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Check Bug Reports for Issues and Fixes
Software is inherently complex and is not free of errors. The output of a code generator might contain
bugs, some of which are not detected by a compiler. MathWorks reports critical known bugs brought
to its attention on its Bug Report system at www.mathworks.com/support/bugreports/. In the search
bar, type the phrase "Incorrect Code Generation" to obtain a report of known bugs that produce code
that might compile and execute, but still produce wrong answers. To save a search, click Save
Search.

The bug reports are an integral part of the documentation for each release. Examine periodically all
bug reports for a release, as such reports may identify inconsistencies between the actual behavior of
a release you are using and the behavior described in this documentation.

In addition to reviewing bug reports, you should implement a verification and validation strategy to
identify potential bugs in your design, code, and tools.

https://www.mathworks.com/support/bugreports/




Model Architecture and Design

Modeling Environment for Embedded Coder
1

Design Models for Generated Embedded Code Deployment . . . . . . . 1-2
Application Algorithms and Run-Time Environments . . . . . . . . . . . . . 1-2
Software Execution Framework for Generated Code . . . . . . . . . . . . . 1-3
Map Embedded System Architecture to Simulink Modeling

Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-4
Model Templates for Code Generation . . . . . . . . . . . . . . . . . . . . . . 1-10

Model Single-Core, Single-Tasking Platform Execution . . . . . . . . . . 1-12

Model Single-Core, Multitasking Platform Execution . . . . . . . . . . . 1-15

Model Concurrent Execution for Symmetric Multicore CPU Platforms
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-18

Model Explicit Function Invocation with Atomic Subsystems . . . . . 1-23

Model Explicit Function Invocation with Function-Call Subsystems
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-26

Modeling in Simulink Coder
2

Blocks and Products Supported for Code Generation . . . . . . . . . . . . 2-2
Related Products . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Simulink Built-In Blocks That Support Code Generation . . . . . . . . . . 2-4
Simulink Block Data Type Support Table . . . . . . . . . . . . . . . . . . . . . 2-20
Block Set Support for Code Generation . . . . . . . . . . . . . . . . . . . . . . 2-20

Modeling Semantic Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21
Data Propagation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-21
Sample Time Propagation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-22
Latches for Subsystem Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23
Block Execution Order . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-24
Algebraic Loops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-25

Modeling Guidelines for Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-27

v

Contents



Modeling Guidelines for Subsystems . . . . . . . . . . . . . . . . . . . . . . . . . 2-28

Modeling Guidelines for Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-29

Modeling Guidelines for MATLAB Functions . . . . . . . . . . . . . . . . . . 2-30

Modeling Guidelines for Model Configuration . . . . . . . . . . . . . . . . . 2-31

Subsystems in Simulink Coder
3

Control Generation of Functions for Subsystems . . . . . . . . . . . . . . . . 3-2
What is a Subsystem Function? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Options for Controlling Generation of Subsystem Function Code . . . . 3-2
Subsystem Function Dependence . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Preserve Subsystem Boundaries in Generated Code . . . . . . . . . . . . . 3-3

Generate Code and Executables for Individual Subsystems . . . . . . . 3-5
Subsystem Build Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6

Inline Subsystem Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
Configure Subsystem to Inline Code . . . . . . . . . . . . . . . . . . . . . . . . . 3-8
Exceptions to Inlining . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-9

Generate Subsystem Code as Separate Function and Files . . . . . . . 3-10

Optimize Code for Identical Nested Subsystems . . . . . . . . . . . . . . . 3-11

Code Generation of Constant Parameters . . . . . . . . . . . . . . . . . . . . . 3-12

Subsystems in Embedded Coder
4

Generate Inlined Subsystem Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Configure Subsystem to Inline Code . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Exceptions to Inlining . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
See Also . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3

Generate Predictable Function Interface to Match Graphical Block
Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4

vi Contents



Referenced Models in Simulink Coder
5

Generate Code for Model Reference Hierarchy . . . . . . . . . . . . . . . . . 5-2
Model Reference Technology . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-2
Generate Code for Model Reference Hierarchy . . . . . . . . . . . . . . . . . 5-2
Working with Code Generation Folders . . . . . . . . . . . . . . . . . . . . . . . 5-6
Build Model Reference Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-7

Set Configuration Parameters for Code Generation of Model
Hierarchies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-9
Configuration Parameter Requirements . . . . . . . . . . . . . . . . . . . . . . 5-9
Configuration Parameters Changed During Code Generation . . . . . 5-11
Naming Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Custom Target Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
Miscellaneous Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12

Convert Subsystem to Referenced Model and Generate Code . . . . . 5-14
Configure Code Mappings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-14
Convert Subsystem to Referenced Model . . . . . . . . . . . . . . . . . . . . 5-14
Copy Code Mappings After Subsystem Conversion . . . . . . . . . . . . . 5-16
Review Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-16

Generate Reusable Code from Model Reference Hierarchy . . . . . . . 5-17

Storage Classes for Parameters and Signals Used in Model Blocks
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-20

Storage Classes for Parameters in Model Blocks . . . . . . . . . . . . . . . 5-20
Storage Classes for Signals in Model Blocks . . . . . . . . . . . . . . . . . . 5-21
Signal Name Mismatches Across Model Reference Boundary . . . . . 5-21

Code Generation Limitations for Model Reference . . . . . . . . . . . . . 5-23
Storage Class Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-23
Data Logging Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-23
State Initialization Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-23
Model Reuse Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-23
S-Functions Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-24
Subsystems Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-24
Targets Limitation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-24
Conditional Models Limitation . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-24

Simulink Cache Files for Incremental Code Generation . . . . . . . . . 5-25
Contents of Simulink Cache Files . . . . . . . . . . . . . . . . . . . . . . . . . . 5-25
Share Code Generation Artifacts . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-25

Specify Instance-Specific Parameter Values for Reusable Referenced
Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-28

Pass Parameter Data to Referenced Model Entry-Point Functions as
Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-28

Control Data Types of Model Arguments and Argument Values . . . . 5-50

vii



Combined Models in Simulink Coder
6

Combine Code Generated for Multiple Models . . . . . . . . . . . . . . . . . . 6-2
Considerations for Combining Code for Different Models . . . . . . . . . 6-2
Control Ownership of Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3
Combine Code Generated for Multiple Models or Multiple Instances of

a Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3

Function Reuse in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-5

File Packaging for Models (Code and Data) . . . . . . . . . . . . . . . . . . . 6-10

Code Reuse for Simulink Coder
7

What Is Code Reuse? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-2

What Is Reentrant Code? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3

Choose a Componentization Technique for Code Reuse . . . . . . . . . . 7-4

Simulink Function Blocks and Code Generation . . . . . . . . . . . . . . . . 7-6
Why Generate Code from Simulink Function Blocks and Function

Callers? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-6
Implementation Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-6
Choose a Modeling Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-6
Specify Function Scope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-8
Decide Whether to Generate Export Function Code . . . . . . . . . . . . . 7-8
Specify Function Code Interface Customizations . . . . . . . . . . . . . . . . 7-8
Uncalled Simulink Function Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . 7-8
Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-9
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-9
Generate and Call Reusable Function Code . . . . . . . . . . . . . . . . . . . . 7-9
Generate Code for a Simulink Function and Function Caller . . . . . . 7-15

Generate Reentrant Code from Top Models . . . . . . . . . . . . . . . . . . . 7-18
Generate Reentrant, Multi-Instance Code . . . . . . . . . . . . . . . . . . . . 7-18
Share Data Between Instances . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-21

Generate Reentrant Code from Simulink Function Blocks . . . . . . . 7-23
Identify Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-23
Create Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-23
Configure Model and Model Elements . . . . . . . . . . . . . . . . . . . . . . 7-25
Generate and Inspect C Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-27
Generate and Inspect C++ Code . . . . . . . . . . . . . . . . . . . . . . . . . . 7-29
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-31

Generate Reentrant Code from Subsystems . . . . . . . . . . . . . . . . . . . 7-33
Function Reuse in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . 7-34
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-38

viii Contents



Generate Reusable Code from Library Subsystems Shared Across
Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-41

What Is a Reusable Library Subsystem? . . . . . . . . . . . . . . . . . . . . . 7-41
Reusable Library Subsystem Code Placement and Naming . . . . . . . 7-41
Configure Reusable Library Subsystem . . . . . . . . . . . . . . . . . . . . . . 7-42
Configure Models That Include Reusable Library Subsystems . . . . . 7-42
Generate Reusable Code for Subsystems Shared Across Models . . . 7-43

Generate Reusable Code from Stateflow Atomic Subcharts . . . . . . 7-50
Generate Reusable Code for Linked Atomic Subcharts . . . . . . . . . . 7-50
Generate Reusable Code for Unlinked Atomic Subcharts . . . . . . . . 7-50
Generate Reusable Code for Unit Testing . . . . . . . . . . . . . . . . . . . . 7-51

Generate Shared Utility Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-56
When to Generate Shared Utility Code . . . . . . . . . . . . . . . . . . . . . . 7-56
Configure Naming of Generated Functions . . . . . . . . . . . . . . . . . . . 7-56
Control Placement of Shared Utility Code . . . . . . . . . . . . . . . . . . . . 7-57
Control Placement of rtwtypes.h for Shared Utility Code . . . . . . . . . 7-58
Avoid Duplicate Header Files for Exported Data . . . . . . . . . . . . . . . 7-58
Reduce Shared Utility Code Generation with Incremental Builds . . 7-58
Manage the Shared Utility Code Checksum . . . . . . . . . . . . . . . . . . 7-59

Generate Shared Utility Code for Fixed-Point Functions . . . . . . . . . 7-64

Generate Shared Utility Code for Custom Data Types . . . . . . . . . . . 7-66

Shared Constant Parameters for Code Reuse . . . . . . . . . . . . . . . . . . 7-68
Suppress Shared Constants in the Generated Code . . . . . . . . . . . . . 7-69

Determine Why Subsystem Code Is Not Reused . . . . . . . . . . . . . . . . 7-71
Review Subsystems Section of HTML Code Generation Report . . . . 7-71
Compare Subsystem Checksum Data . . . . . . . . . . . . . . . . . . . . . . . 7-71

Library-Based Code Generation
8

Library-Based Code Generation for Reusable Library Subsystems
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2

Example Model and Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-2
Configure Reusable Library Subsystems . . . . . . . . . . . . . . . . . . . . . . 8-3
Specify Unique Function Interface Names . . . . . . . . . . . . . . . . . . . . 8-3
Configure and Manage Function Interfaces . . . . . . . . . . . . . . . . . . . . 8-4
Build the Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-7
Generate Code from Model Containing a Reusable Library Subsystem

Instance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-8
Verify Code Generated from Reusable Library Subsystems . . . . . . . . 8-9
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-10

ix



Configure Model Parameters for Simulink Coder
9

Configure Run-Time Environment Options . . . . . . . . . . . . . . . . . . . . . 9-2
Configure Production and Test Hardware . . . . . . . . . . . . . . . . . . . . . 9-2
Production Hardware Considerations . . . . . . . . . . . . . . . . . . . . . . . . 9-7
Test Hardware Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-8
Example Production Hardware Setting That Affects Normal Mode

Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-8

Register New Hardware Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-11
Specify Hardware Implementation for New Device . . . . . . . . . . . . . 9-11
Specify Hardware Implementation That Persists Over MATLAB

Sessions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-12
Create Hardware Implementation by Modifying Existing

Implementation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-12
Create Hardware Implementation by Reusing Existing Implementation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-12
Validate Hardware Device Data . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-13
Export Hardware Device Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-14
Create Alternative Identifier for Target Object . . . . . . . . . . . . . . . . 9-14
Upgrade Data Definitions for Hardware Devices . . . . . . . . . . . . . . . 9-15

Model Protection in Simulink Coder
10

Protect Models to Conceal Contents . . . . . . . . . . . . . . . . . . . . . . . . . 10-2
Prepare the Parent Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-3
Protect the Referenced Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-3
Protected Model Requirements and Limitations . . . . . . . . . . . . . . . 10-7
Code Generation Requirements and Limitations . . . . . . . . . . . . . . . 10-7
Nested Protected Model Requirements and Limitations . . . . . . . . . 10-8

Create Protected Models with Multiple Targets . . . . . . . . . . . . . . . 10-10

Test Protected Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-11

Package and Share Protected Models . . . . . . . . . . . . . . . . . . . . . . . 10-13
Harness Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-13
MAT-File with Base Workspace Definitions . . . . . . . . . . . . . . . . . . 10-13
Simulink Data Dictionary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-14
Protected Model File Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-14

Specify Custom Obfuscators for Protected Models . . . . . . . . . . . . 10-17

Define Callbacks for Protected Models . . . . . . . . . . . . . . . . . . . . . . 10-18
Creating Callbacks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-18
Defining Callback Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-18
Create a Protected Model with Callbacks . . . . . . . . . . . . . . . . . . . 10-19

x Contents



Sign a Protected Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-20
Sign Your Protected Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-20

Best Practices for Creating Protected Models . . . . . . . . . . . . . . . . 10-22
Coordinate Settings with the User of Your Protected Model . . . . . 10-22
Minimize the Model External Interface . . . . . . . . . . . . . . . . . . . . . 10-22
Contents to Include in Your Protected Model . . . . . . . . . . . . . . . . 10-24

Component Initialization, Reset, and Termination in
Simulink Coder

11
Generate Code That Responds to Initialize, Reset, and Terminate

Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-2
Generate Code for Initialize and Terminate Events . . . . . . . . . . . . . 11-2
Generate Code for Reset Events . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-5
Event Names and Code Aggregation . . . . . . . . . . . . . . . . . . . . . . . . 11-7
Limitation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-8

Stateflow Blocks in Simulink Coder
12

Code Generation of Stateflow Blocks . . . . . . . . . . . . . . . . . . . . . . . . . 12-2
Comparison of Code Generation Methods . . . . . . . . . . . . . . . . . . . . 12-2

Generate Code from Atomic Subcharts . . . . . . . . . . . . . . . . . . . . . . . 12-5
Generate Reusable Code for Unlinked Atomic Subcharts . . . . . . . . 12-5
Generate Reusable Code for Linked Atomic Subcharts . . . . . . . . . . 12-5

Inline State Functions in Generated Code . . . . . . . . . . . . . . . . . . . . 12-7
Inlined Generated Code for State Functions . . . . . . . . . . . . . . . . . . 12-7
How to Set the State Function Inline Option . . . . . . . . . . . . . . . . . . 12-8
Best Practices for Controlling State Function Inlining . . . . . . . . . . . 12-8

Air-Fuel Ratio Control System with Stateflow Charts . . . . . . . . . . . 12-10

Block Authoring and Code Generation for Simulink Coder
13

S-Functions and Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-2
Types of S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-2
Files Required for Implementing Noninlined and Inlined S-Functions

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-4
Guidelines for Writing S-Functions that Support Code Generation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-4

xi



Import Calls to External Code into Generated Code with Legacy Code
Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-6

Legacy Code Tool and Code Generation . . . . . . . . . . . . . . . . . . . . . 13-6
Generate Inlined S-Function Files for Code Generation . . . . . . . . . . 13-6
Apply Code Style Settings to Legacy Functions . . . . . . . . . . . . . . . . 13-7
Address Dependencies on Files in Different Locations . . . . . . . . . . . 13-8
Deploy S-Functions for Simulation and Code Generation . . . . . . . . . 13-8
Integrate External C++ Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-8

Legacy Code Tool Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-11
Integrate External C Functions That Pass Input Arguments By Value

Versus Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-11
Integrate External C Functions That Pass the Output Argument As a

Return Argument . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-14
Integrate External C++ Object Methods . . . . . . . . . . . . . . . . . . . . 13-16
Integrate External C Functions That Pass Input and Output Arguments

as Parameters with a Fixed-Point Data Type . . . . . . . . . . . . . . . 13-18
Integrate External C Functions That Pass Input and Output Arguments

as Signals with a Fixed-Point Data Type . . . . . . . . . . . . . . . . . . 13-21
Integrate External C Functions with Instance-Specific Persistent

Memory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-23
Integrate External C Functions That Use Structure Arguments . . . 13-25
Integrate External C Functions That Pass Input and Output Arguments

as Signals with Complex Data . . . . . . . . . . . . . . . . . . . . . . . . . . 13-28
Integrate External C Functions That Pass Arguments That Have

Inherited Dimensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-30
Integrate External C Functions That Pass Arguments as Multi-

Dimensional Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-33
Integrate External C Functions That Implement Start and Terminate

Actions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-35
Integrate External C Functions That Implement N-Dimensional Table

Lookups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-37
Integrate External C Functions That Pass Arguments as Multi-

Dimensional Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-40
Integrate External C Functions with a Block Sample Time Specified,

Inherited, and Parameterized . . . . . . . . . . . . . . . . . . . . . . . . . . 13-42

Integrate External C Functions That Pass Input and Output
Arguments as Parameters with a Fixed-Point Data Type . . . . . . 13-47

Integrate External C Functions That Implement N-Dimensional Table
Lookups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-50

Integrate External C++ Object Methods . . . . . . . . . . . . . . . . . . . . . 13-53

External Code Integration Examples . . . . . . . . . . . . . . . . . . . . . . . . 13-56
Integrate External C++ Code into a Model Using S-Functions . . . 13-56
Insert External C and C++ Code Into Stateflow Charts for Code

Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-57
Integrate External C Code Into Generated Code By Using Custom

Code Blocks and Model Configuration Parameters . . . . . . . . . . 13-58
Integrate External C Code Into Generated Code By Using Custom

Code Blocks and Model Configuration Parameters . . . . . . . . . . 13-60
Insert External C++ Code Into Stateflow Charts for Code Generation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-62

xii Contents



Generate S-Function from Subsystem . . . . . . . . . . . . . . . . . . . . . . . 13-64
Macro Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-66

S-Functions That Support Expression Folding . . . . . . . . . . . . . . . . 13-68
Categories of Output Expressions . . . . . . . . . . . . . . . . . . . . . . . . . 13-68
Acceptance or Denial of Requests for Input Expressions . . . . . . . . 13-71
Expression Folding in a TLC Block Implementation . . . . . . . . . . . . 13-73

S-Functions That Specify Port Scope and Reusability . . . . . . . . . . 13-77

S-Functions That Specify Sample Time Inheritance Rules . . . . . . 13-81

S-Functions for Code Reuse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-85

S-Functions for Multirate Multitasking Environments . . . . . . . . . 13-90
About S-Functions for Multirate Multitasking Environments . . . . . 13-90
Rate Grouping Support in S-Functions . . . . . . . . . . . . . . . . . . . . . 13-90
Create Multitasking, Multirate, Port-Based Sample Time S-Functions

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-90

Write Noninlined S-Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-95
Guidelines for Writing Noninlined S-Functions . . . . . . . . . . . . . . . 13-95
Noninlined S-Function Parameter Type Limitations . . . . . . . . . . . 13-96

Write Wrapper S-Function and TLC Files . . . . . . . . . . . . . . . . . . . . 13-97
MEX S-Function Wrapper . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-97
TLC S-Function Wrapper . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-100
Code Overhead for Noninlined S-Functions . . . . . . . . . . . . . . . . 13-100
Inline a Wrapper S-Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-101
The Inlined Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-103

Write Fully Inlined S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-104
Multiport S-Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-104
Guidelines for Writing Inlined S-Functions . . . . . . . . . . . . . . . . . 13-104

Write Fully Inlined S-Functions with mdlRTW Routine . . . . . . . . 13-106
S-Function RTWdata . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-106
Direct-Index Lookup Table Algorithm . . . . . . . . . . . . . . . . . . . . . 13-107
Direct-Index Lookup Table Example . . . . . . . . . . . . . . . . . . . . . . 13-108
Error Handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-109
User Data Caching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-109
mdlRTW Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-109

What is the Target Language Compiler?
14

Target Language Compiler Basics . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-2
Target Language Compiler Overview . . . . . . . . . . . . . . . . . . . . . . . 14-2
Overview of the TLC Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-2
Overview of the Code Generation Process . . . . . . . . . . . . . . . . . . . . 14-4

xiii



Why Use the Target Language Compiler? . . . . . . . . . . . . . . . . . . . . . 14-6
Customizing Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-6
Inlining S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-6
Defining Advanced Storage Classes . . . . . . . . . . . . . . . . . . . . . . . . 14-6

The Advantages of Inlining S-Functions . . . . . . . . . . . . . . . . . . . . . . 14-8
When To Avoid Inlining . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-8
Inlining Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-8
Search Algorithm for Locating TLC Files . . . . . . . . . . . . . . . . . . . . 14-9
Availability for Inlining and Noninlining . . . . . . . . . . . . . . . . . . . . . 14-9

Getting Started
15

Code Architecture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-2
Code Generation Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-3
How TLC Determines S-Function Inlining Status . . . . . . . . . . . . . . 15-3
Inlined and Noninlined S-Function Code . . . . . . . . . . . . . . . . . . . . . 15-3

Target Language Compiler Process . . . . . . . . . . . . . . . . . . . . . . . . . . 15-6
model.rtw Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-6
Operating Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-6

Inlining S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-8
Inlining an S-function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-8
Noninlined S-Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-8
Types of Inlining . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-9
Fully Inlined S-Function Example . . . . . . . . . . . . . . . . . . . . . . . . . . 15-9
Wrapper Inlined S-Function Example . . . . . . . . . . . . . . . . . . . . . . 15-11

Target Language Compiler Tutorials
16

Advice About TLC Tutorials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-2

Read Record Files with TLC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-4
Tutorial Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-4
Structure of Record Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-4
Interpret Records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-5
Anatomy of a TLC Script . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-6
Modify read-guide.tlc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-11
Pass and Use a Parameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-14
Review . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-16

Inline S-Functions with TLC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-17
timesN Tutorial Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-17
Noninlined Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-17
Why Use TLC to Inline S-Functions? . . . . . . . . . . . . . . . . . . . . . . . 16-18
Create an Inlined S-Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-18

xiv Contents



Explore Variable Names and Loop Rolling . . . . . . . . . . . . . . . . . . . 16-21
timesN Looping Tutorial Overview . . . . . . . . . . . . . . . . . . . . . . . . 16-21
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-21
Modify the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-21
Change the Loop Rolling Threshold . . . . . . . . . . . . . . . . . . . . . . . 16-23
More About TLC Loop Rolling . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-24

Debug Your TLC Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-26
tlcdebug Tutorial Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-26
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-26
Generate and Run Code from the Model . . . . . . . . . . . . . . . . . . . . 16-27
Start the Debugger and Use Its Commands . . . . . . . . . . . . . . . . . 16-28
Debug timesN.tlc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-29
Fix the Bug and Verify . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-30

TLC Code Coverage to Aid Debugging . . . . . . . . . . . . . . . . . . . . . . . 16-32
tlcdebug Execute Tutorial Overview . . . . . . . . . . . . . . . . . . . . . . . 16-32
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-32
Open the Model and Generate Code . . . . . . . . . . . . . . . . . . . . . . . 16-32

Wrap User Code with TLC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-34
wrapper Tutorial Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-34
Why Wrap User Code? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-34
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-36
Generate Code Without a Wrapper . . . . . . . . . . . . . . . . . . . . . . . . 16-36
Generate Code Using a Wrapper . . . . . . . . . . . . . . . . . . . . . . . . . . 16-37

Code Generation Architecture
17

Build Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-2
Build Process Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-2
Create and Use Target Language File . . . . . . . . . . . . . . . . . . . . . . . 17-2

Configure TLC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-5
Set Command-Line Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-5
Configure for TLC Debugging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-6

Code Generation Concepts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-7
Output Streams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-7
Variable Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-7
Records . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-8
Record Aliases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-9

TLC Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-11
TLC Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-11
Available Target Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-11
Target File Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-12
System Target Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-13

Data Handling with TLC . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-14
Matrix Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-14

xv



Code Generator Matrix Parameters . . . . . . . . . . . . . . . . . . . . . . . 17-14

model.rtw File and Authoring S-Functions and Data
Objects

18
model.rtw File and Scopes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-2

Scopes in the model.rtw File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-2

Data Object Information in model.rtw File . . . . . . . . . . . . . . . . . . . . 18-5
Object Records for Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-5
Object Records for Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-6
Access Data Object Information by Using Target Language Compiler

(TLC) Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-7

Data References in the model.rtw File . . . . . . . . . . . . . . . . . . . . . . . 18-9
Data Reference Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-9
Control the Data Reference Threshold . . . . . . . . . . . . . . . . . . . . . . 18-9
Expand Data References . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-9
Avoid Data Reference Expansion . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-9
Restart Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-10

Exception to Using the Library Functions that Access model.rtw
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-11

Example Exception to Using the Library Functions . . . . . . . . . . . . 18-11
Caution Against Directly Accessing Record Fields . . . . . . . . . . . . . 18-12

Directives and Built-In Functions
19

Target Language Compiler Directives . . . . . . . . . . . . . . . . . . . . . . . . 19-2
Syntax . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-2
Directives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-2
Comments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-12
Line Continuation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-13
Target Language Value Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-13
Target Language Expressions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-14
Formatting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-19
Conditional Inclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-19
Multiple Inclusion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-20
Object-Oriented Facility for Generating Target Code . . . . . . . . . . . 19-23
Output File Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-25
Input File Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-26
Asserts, Errors, Warnings, and Debug Messages . . . . . . . . . . . . . . 19-27
Built-In Functions and Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-27
TLC Reserved Constants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-35
Identifier Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-35
Variable Scoping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-38
Target Language Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-45

xvi Contents



Command-Line Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-48
Target Language Compiler Switches . . . . . . . . . . . . . . . . . . . . . . . 19-48
Filenames and Search Paths . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-50

Debugging TLC Files
20

Using the TLC Debugger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-2
Tips for Debugging TLC Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-2
Invoking the Debugger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-2
TLC Debugger Command Summary . . . . . . . . . . . . . . . . . . . . . . . . 20-3

TLC Coverage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-6
Using the TLC Coverage Option . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-6
Example .log File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-6
Analyzing the Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-8

TLC Profiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-9
Using the Profiler . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-9
Analyzing the Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-9
Nonexecutable Directives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-10
Improving Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-10

Inlining S-Functions
21

Inline S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-2
Inline S-Functions with Block Target Files . . . . . . . . . . . . . . . . . . . 21-2
Inline MATLAB File S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-3
Inline Fortran (F-MEX) S-Functions . . . . . . . . . . . . . . . . . . . . . . . . 21-4

Inline C MEX S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-8
Inline S-Function Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-8
S-Function Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-9
Sample Code for S-Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-9

TLC Coding Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-17
Begin Identifiers with Uppercase Letters . . . . . . . . . . . . . . . . . . . 21-17
Begin Global Variable Assignments with Uppercase Letters . . . . . 21-17
Begin Local Variable Assignments with Lowercase Letters . . . . . . 21-18
Begin Functions Declared in block.tlc Files with Fcn . . . . . . . . . . 21-18
Do Not Hard-Code Variables Defined in commonsetup.tlc . . . . . . . 21-18
Conditional Inclusion in Library Files . . . . . . . . . . . . . . . . . . . . . . 21-19
Code Defensively . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-20

Block Target File Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-21
Block Functions Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-21
BlockInstanceSetup(block, system) . . . . . . . . . . . . . . . . . . . . . . . . 21-21
BlockTypeSetup(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . 21-22

xvii



Enable(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-23
Disable(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-23
Start(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-23
InitializeConditions(block, system) . . . . . . . . . . . . . . . . . . . . . . . . 21-24
Outputs(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-24
Update(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-25
Derivatives(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-26
Terminate(block, system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-26

Loop Rolling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-27

TLC Function Library Reference
22

Target Language Compiler Library Functions Overview . . . . . . . . . 22-2

Target Language Compiler Function Conventions . . . . . . . . . . . . . . 22-3
Common Function Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-3
Overloading sigIdx . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-4

Input Signal Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-7
LibBlockInputHasSymbolicWidth(portIdx) . . . . . . . . . . . . . . . . . . . 22-7
LibBlockInputPortIndexMode(block, pidx) . . . . . . . . . . . . . . . . . . . 22-7
LibBlockInputPortIsContinuousQuantity(portIdx) . . . . . . . . . . . . . . 22-7
LibBlockInputSignal(portIdx, ucv, lcv, sigIdx) . . . . . . . . . . . . . . . . . 22-8
LibBlockInputSignalAddr(portIdx, ucv, lcv, sigIdx) . . . . . . . . . . . . 22-12
LibBlockInputSignalAliasedThruDataTypeName(portIdx, reim) . . . 22-13
LibBlockInputSignalAllowScalarExpandedExpr(block,portIdx) . . . 22-13
LibBlockInputSignalASCIIEscapedUnitExpr(portIdx) . . . . . . . . . . 22-13
LibBlockInputSignalConnected(portIdx) . . . . . . . . . . . . . . . . . . . . 22-14
LibBlockInputSignalDataTypeId(portIdx) . . . . . . . . . . . . . . . . . . . 22-14
LibBlockInputSignalDataTypeName(portIdx, reim) . . . . . . . . . . . . 22-14
LibBlockInputSignalDimensions(portIdx) . . . . . . . . . . . . . . . . . . . 22-14
LibBlockInputSignalIsComplex(portIdx) . . . . . . . . . . . . . . . . . . . . 22-14
LibBlockInputSignalIsExpr(portIdx) . . . . . . . . . . . . . . . . . . . . . . . 22-14
LibBlockInputSignalIsFrameData(portIdx) . . . . . . . . . . . . . . . . . . 22-15
LibBlockInputSignalIsTrivialExpr(portIdx) . . . . . . . . . . . . . . . . . . 22-15
LibBlockInputSignalLocalSampleTimeIndex(portIdx) . . . . . . . . . . 22-15
LibBlockInputSignalNumDimensions(portIdx) . . . . . . . . . . . . . . . 22-15
LibBlockInputSignalOffsetTime(portIdx) . . . . . . . . . . . . . . . . . . . . 22-15
LibBlockInputSignalSampleTime(portIdx) . . . . . . . . . . . . . . . . . . . 22-15
LibBlockInputSignalSampleTimeIndex(portIdx) . . . . . . . . . . . . . . 22-15
LibBlockInputSignalSymbolicDimensions(portIdx) . . . . . . . . . . . . 22-15
LibBlockInputSignalSymbolicWidth(portIdx) . . . . . . . . . . . . . . . . . 22-16
LibBlockInputSignalWidth(portIdx) . . . . . . . . . . . . . . . . . . . . . . . . 22-16
LibBlockInputSignalUnitExpr(portIdx) . . . . . . . . . . . . . . . . . . . . . 22-16
LibBlockInputSignalUnitId(portIdx) . . . . . . . . . . . . . . . . . . . . . . . 22-16
LibBlockNumInputPorts(block) . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-16

Output Signal Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-17
LibBlockAssignOutputSignal(portIdx, ucv, lcv, sigIdx, rhs) . . . . . . 22-17
LibBlockGetNumFcnCallOutputs(block) . . . . . . . . . . . . . . . . . . . . 22-17

xviii Contents



LibBlockGetNumFcnCallOutputsDsts(block) . . . . . . . . . . . . . . . . . 22-17
LibBlockNumOutputPorts(block) . . . . . . . . . . . . . . . . . . . . . . . . . 22-17
LibBlockOutputHasSymbolicWidth(portIdx) . . . . . . . . . . . . . . . . . 22-17
LibBlockOutputPortIndexMode(block, pidx) . . . . . . . . . . . . . . . . . 22-17
LibBlockOutputPortIsContinuousQuantity(portIdx) . . . . . . . . . . . . 22-18
LibBlockOutputSignal(portIdx, ucv, lcv, sigIdx) . . . . . . . . . . . . . . . 22-18
LibBlockOutputSignalAddr(portIdx, ucv, lcv, sigIdx) . . . . . . . . . . . 22-18
LibBlockOutputSignalAliasedThruDataTypeName(portIdx, reim) . 22-19
LibBlockOutputSignalBeingMerged(portIdx) . . . . . . . . . . . . . . . . 22-19
LibBlockOutputSignalConnected(portIdx) . . . . . . . . . . . . . . . . . . . 22-19
LibBlockOutputSignalDataTypeId(portIdx) . . . . . . . . . . . . . . . . . . 22-19
LibBlockOutputSignalDataTypeName(portIdx, reim) . . . . . . . . . . . 22-20
LibBlockOutputSignalDimensions(portIdx) . . . . . . . . . . . . . . . . . . 22-20
LibBlockOutputSignalIsComplex(portldx) . . . . . . . . . . . . . . . . . . . 22-20
LibBlockOutputSignalIsConstExpr(portIdx) . . . . . . . . . . . . . . . . . 22-20
LibBlockOutputSignalIsExpr(portldx) . . . . . . . . . . . . . . . . . . . . . . 22-20
LibBlockOutputSignalIsExprInOutputs(portIdx) . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalIsFrameData(portIdx) . . . . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalIsNonConstExpr(portIdx) . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalIsTrivialExpr(portIdx) . . . . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalLocalSampleTimeIndex(portIdx) . . . . . . . . . 22-21
LibBlockOutputSignalNumDimensions(portIdx) . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalOffsetTime(portIdx) . . . . . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalSampleTime(portIdx) . . . . . . . . . . . . . . . . . 22-21
LibBlockOutputSignalSampleTimeIndex(portIdx) . . . . . . . . . . . . . 22-22
LibBlockOutputSignalSymbolicDimensions(portIdx) . . . . . . . . . . . 22-22
LibBlockOutputSignalSymbolicWidth(portIdx) . . . . . . . . . . . . . . . 22-22
LibBlockOutputSignalWidth(portIdx) . . . . . . . . . . . . . . . . . . . . . . 22-22
LibBlockOutputSignalUnitExpr(portIdx) . . . . . . . . . . . . . . . . . . . . 22-22
LibBlockOutputSignalUnitId(portIdx) . . . . . . . . . . . . . . . . . . . . . . 22-22

Parameter Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-23
LibBlockMatrixParameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-23
LibBlockMatrixParameterAddr . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-23
LibBlockMatrixParameterBaseAddr . . . . . . . . . . . . . . . . . . . . . . . 22-23
LibBlockParamSetting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-23
LibBlockParameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-23
LibBlockParameterAddr . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-25
LibBlockParameterBaseAddr . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-25
LibBlockParameterDataTypeId . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-25
LibBlockParameterDataTypeName . . . . . . . . . . . . . . . . . . . . . . . . 22-25
LibBlockParameterDimensions . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-25
LibBlockParameterIsComplex . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-26
LibBlockParameterSize . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-26
LibBlockParameterString . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-26
LibBlockParameterValue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-26
LibBlockParameterWidth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-27

Block State and Work Vector Functions . . . . . . . . . . . . . . . . . . . . . 22-28
LibBlockAssignDWork(dwork, ucv, lcv, sigIdx, rhs) . . . . . . . . . . . . 22-28
LibBlockContinuousState(ucv, lcv, idx) . . . . . . . . . . . . . . . . . . . . . 22-28
LibBlockContinuousStateDerivative(ucv, lcv, idx) . . . . . . . . . . . . . 22-28
LibBlockContStateDisabled(ucv, lcv, idx) . . . . . . . . . . . . . . . . . . . . 22-28
LibBlockDWork(dwork, ucv, lcv, idx) . . . . . . . . . . . . . . . . . . . . . . . 22-28
LibBlockDWorkAddr(dwork, ucv, lcv, idx) . . . . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkDataTypeId(dwork) . . . . . . . . . . . . . . . . . . . . . . . . 22-29

xix



LibBlockDWorkDataTypeName(dwork, reim) . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkIsComplex(dwork) . . . . . . . . . . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkName(dwork) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkStorageClass(dwork) . . . . . . . . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkStorageTypeQualifier(dwork) . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkUsedAsDiscreteState(dwork) . . . . . . . . . . . . . . . . 22-29
LibBlockDWorkWidth(dwork) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-30
LibBlockDiscreteState(ucv, lcv, idx) . . . . . . . . . . . . . . . . . . . . . . . 22-30
LibBlockIWork(definediwork, ucv, lcv, idx) . . . . . . . . . . . . . . . . . . 22-30
LibBlockMode(ucv, lcv, idx) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-30
LibBlockNonSampledZC(ucv, lcv, NSZCIdx) . . . . . . . . . . . . . . . . . 22-30
LibBlockPWork(definedpwork, ucv, lcv, idx) . . . . . . . . . . . . . . . . . . 22-30
LibBlockRWork(definedrwork, ucv, lcv, idx) . . . . . . . . . . . . . . . . . . 22-30
LibBlockZCSignalValue(ucv, lcv, zcsIdx, zcElIdx) . . . . . . . . . . . . . . 22-31

Block Path and Error Reporting Functions . . . . . . . . . . . . . . . . . . . 22-32
LibBlockReportError(block, errorstring) . . . . . . . . . . . . . . . . . . . . 22-32
LibBlockReportFatalError(block, errorstring) . . . . . . . . . . . . . . . . 22-32
LibBlockReportWarning(block, warnstring) . . . . . . . . . . . . . . . . . . 22-32
LibGetBlockName(block) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-32
LibGetBlockPath(block) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-33
LibGetFormattedBlockPath(block) . . . . . . . . . . . . . . . . . . . . . . . . 22-33

Code Configuration Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-34
LibAddSourceFileCustomSection(file, builtInSection, newSection)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-34
LibAddToCommonIncludes(incFileName) . . . . . . . . . . . . . . . . . . . 22-34
LibAddToModelSources(newFile) . . . . . . . . . . . . . . . . . . . . . . . . . 22-34
LibCacheDefine(buffer) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-35
LibCacheExtern(buffer) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-35
LibCacheFunctionPrototype(buffer) . . . . . . . . . . . . . . . . . . . . . . . 22-35
LibCacheTypedefs(buffer) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-36
LibCallModelInitialize() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-36
LibCallModelStep(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-36
LibCallModelTerminate() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-36
LibCallSetEventForThisBaseStep(buffername) . . . . . . . . . . . . . . . 22-36
LibClearFileSectionContents(fileIdx, attrib) . . . . . . . . . . . . . . . . . 22-36
LibCreateSourceFile(type, creator, name) . . . . . . . . . . . . . . . . . . . 22-37
LibGetFileRecordName (file) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-37
LibGetMdlPrvHdrBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-37
LibGetMdlPubHdrBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-37
LibGetMdlSrcBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlDataSrcBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlTypesHdrBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlCapiHdrBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlCapiSrcBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlCapiHostHdrBaseName() . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlTestIfHdrBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetMdlTestIfSrcBaseName() . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
LibGetDataTypeTransHdrBaseName() . . . . . . . . . . . . . . . . . . . . . 22-39
LibGetModelDotCFile() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-39
LibGetModelDotHFile() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-39
LibGetModelName() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-39
LibGetNumSourceFiles() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-39
LibGetRTModelErrorStatus() . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-40
LibGetSourceFileAttribute(fileIdx, attrib) . . . . . . . . . . . . . . . . . . . 22-40

xx Contents



LibGetSourceFileFromIdx(fileIdx) . . . . . . . . . . . . . . . . . . . . . . . . . 22-40
LibGetSourceFileSection(fileIdx, section) . . . . . . . . . . . . . . . . . . . 22-41
LibGetSourceFileTag(fileIdx) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-41
LibMdlRegCustomCode(buffer, location) . . . . . . . . . . . . . . . . . . . . 22-41
LibMdlStartCustomCode(buffer, location) . . . . . . . . . . . . . . . . . . . 22-42
LibMdlTerminateCustomCode(buffer, location) . . . . . . . . . . . . . . . 22-42
LibSetRTModelErrorStatus(str) . . . . . . . . . . . . . . . . . . . . . . . . . . 22-43
LibSetSourceFileCodeTemplate(opFile, name) . . . . . . . . . . . . . . . 22-43
LibSetSourceFileCustomSection(file, attrib, value) . . . . . . . . . . . . 22-44
LibSetSourceFileOutputDirectory(opFile, name) . . . . . . . . . . . . . . 22-44
LibSetSourceFileSection(fileH, section, value) . . . . . . . . . . . . . . . 22-44
LibSystemDerivativeCustomCode(system, buffer, location) . . . . . . 22-46
LibSystemDisableCustomCode(system, buffer, location) . . . . . . . . 22-47
LibSystemEnableCustomCode(system, buffer, location) . . . . . . . . . 22-47
LibSystemInitializeCustomCode(system, buffer, location) . . . . . . . 22-48
LibSystemOutputCustomCode(system, buffer, location) . . . . . . . . 22-49
LibSystemUpdateCustomCode(system, buffer, location) . . . . . . . . 22-50
LibWriteModelData() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-51
LibWriteModelInput(tid, rollThreshold) . . . . . . . . . . . . . . . . . . . . . 22-51
LibWriteModelInputs() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-52
LibWriteModelOutput(tid, rollThreshold) . . . . . . . . . . . . . . . . . . . 22-52
LibWriteModelOutputs() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-52

Sample Time Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-53
LibAsynchronousTriggeredTID(tid) . . . . . . . . . . . . . . . . . . . . . . . . 22-53
LibAsyncTaskAccessTimeInFcn(tid, fcnType) . . . . . . . . . . . . . . . . 22-53
LibBlockSampleTime(block) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-53
LibGetClockTick(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-53
LibGetClockTickDataTypeId(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . 22-53
LibGetClockTickHigh(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-53
LibGetClockTickStepSize(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-54
LibGetElapseTime(system) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-54
LibGetElapseTimeCounter(system) . . . . . . . . . . . . . . . . . . . . . . . . 22-54
LibGetElapseTimeCounterDTypeId(system) . . . . . . . . . . . . . . . . . 22-54
LibGetElapseTimeResolution(system) . . . . . . . . . . . . . . . . . . . . . . 22-54
LibGetGlobalTIDFromLocalSFcnTID(sfcnTID) . . . . . . . . . . . . . . . . 22-54
LibGetNumAsyncTasks() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-55
LibGetNumSFcnSampleTimes(block) . . . . . . . . . . . . . . . . . . . . . . 22-55
LibGetNumSyncPeriodicTasks() . . . . . . . . . . . . . . . . . . . . . . . . . . 22-56
LibGetNumTasks() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-56
LibGetSampleTimePeriodAndOffset(tid, idx) . . . . . . . . . . . . . . . . . 22-56
LibGetSFcnTIDType(sfcnTID) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-56
LibGetTaskTime(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-57
LibGetTaskTimeFromTID(block) . . . . . . . . . . . . . . . . . . . . . . . . . . 22-57
LibGetTID01EQ() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-57
LibIsContinuous(TID) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-57
LibIsDiscrete(TID) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-58
LibIsSFcnSampleHit(sfcnTID) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-58
LibIsSFcnSingleRate(block) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-58
LibIsSFcnSpecialSampleHit(sfcnSTI, sfcnTID) . . . . . . . . . . . . . . . 22-58
LibIsSingleRateModel() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-59
LibIsSingleTasking() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-59
LibIsZOHContinuous(TID) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-59
LibNumAsynchronousSampleTimes() . . . . . . . . . . . . . . . . . . . . . . 22-59
LibNumDiscreteSampleTimes() . . . . . . . . . . . . . . . . . . . . . . . . . . 22-59
LibNumSynchronousSampleTimes() . . . . . . . . . . . . . . . . . . . . . . . 22-60

xxi



LibPortBasedSampleTimeBlockIsTriggered(block) . . . . . . . . . . . . 22-60
LibSetVarNextHitTime(block, tNext) . . . . . . . . . . . . . . . . . . . . . . . 22-60
LibTriggeredTID(tid) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-60

Miscellaneous Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-61
LibAddtoSystemCustomIncludes(system, incFileName) . . . . . . . . 22-61
LibBlockExecuteFcnCall(block, callIdx) . . . . . . . . . . . . . . . . . . . . 22-61
LibBlockExecuteFcnDisable(block, callIdx) . . . . . . . . . . . . . . . . . . 22-61
LibBlockExecuteFcnEnable(block, callIdx) . . . . . . . . . . . . . . . . . . 22-62
LibBlockInputSignalAliasedThruDataTypeId(idx) . . . . . . . . . . . . . 22-62
LibBlockOutputSignalAliasedThruDataTypeId(idx) . . . . . . . . . . . . 22-62
LibGenConstVectWithInit(data, typeId, varId) . . . . . . . . . . . . . . . . 22-62
LibGetBlockAttribute(block, attr) . . . . . . . . . . . . . . . . . . . . . . . . . 22-62
LibGetCallerClockTickCounter(sfcnBlock) . . . . . . . . . . . . . . . . . . 22-63
LibGetCallerClockTickCounterHigh(sfcnBlock) . . . . . . . . . . . . . . . 22-63
LibGetDataTypeComplexNameFromId(id) . . . . . . . . . . . . . . . . . . . 22-63
LibGetDataTypeEnumFromId(id) . . . . . . . . . . . . . . . . . . . . . . . . . 22-63
LibGetDataTypeIdAliasedThruToFromId(id) . . . . . . . . . . . . . . . . . 22-64
LibGetDataTypeIdAliasedToFromId(id) . . . . . . . . . . . . . . . . . . . . . 22-64
LibGetDataTypeIdResolvesToFromId(id) . . . . . . . . . . . . . . . . . . . . 22-64
LibGetDataTypeNameFromId(id) . . . . . . . . . . . . . . . . . . . . . . . . . 22-64
LibGetDataTypeSLSizeFromId(id) . . . . . . . . . . . . . . . . . . . . . . . . 22-64
LibGetDataTypeStorageIdFromId(id) . . . . . . . . . . . . . . . . . . . . . . 22-64
LibGetFcnCallBlock(sfcnblock,callIdx) . . . . . . . . . . . . . . . . . . . . . 22-65
LibGetRecordDataTypeId(rec) . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-65
LibGetRecordDimensions(rec) . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-65
LibGetRecordIsComplex(rec) . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-65
LibGetRecordWidth(rec) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-65
LibGetT() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-65
LibIsComplex(arg) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-66
LibIsFirstInitCond() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-66
LibIsMajorTimeStep() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-66
LibIsMinorTimeStep() . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-66
LibManageAsyncCounter(sfcnBlock, callIdx) . . . . . . . . . . . . . . . . 22-66
LibMaxIntValue(dtype) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-67
LibMinIntValue(dtype) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-67
LibNeedAsyncCounter(sfcnBlock, callIdx) . . . . . . . . . . . . . . . . . . . 22-67
LibSetAsyncClockTicks(sfcnBlock, callIdx, buf1, buf2) . . . . . . . . . 22-67
LibSetAsyncCounter(sfcnBlock, callIdx, buf) . . . . . . . . . . . . . . . . . 22-68
LibSetAsyncCounterHigh(sfcnBlock, callIdx, buf) . . . . . . . . . . . . . 22-68
LibTIDInSystem(system, fcnType) . . . . . . . . . . . . . . . . . . . . . . . . . 22-68
LibIsRowMajor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-69
Obsolete Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-69

Advanced Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-71
LibAppendToModelReferenceUserData(data) . . . . . . . . . . . . . . . . 22-71
LibBlockInputSignalBufferDstPort(portIdx) . . . . . . . . . . . . . . . . . . 22-71
LibBlockInputSignalStorageClass(portIdx, sigIdx) . . . . . . . . . . . . 22-72
LibBlockInputSignalStorageTypeQualifier(portIdx, sigIdx) . . . . . . 22-72
LibBlockOutputSignalIsGlobal(portIdx) . . . . . . . . . . . . . . . . . . . . . 22-72
LibBlockOutputSignalIsInBlockIO(portIdx) . . . . . . . . . . . . . . . . . . 22-72
LibBlockOutputSignalIsValidLValue(portIdx) . . . . . . . . . . . . . . . . . 22-72
LibBlockOutputSignalStorageClass(portIdx) . . . . . . . . . . . . . . . . . 22-73
LibBlockOutputSignalStorageTypeQualifier(portIdx) . . . . . . . . . . 22-73
LibBlockSrcSignalBlock(portIdx, sigIdx) . . . . . . . . . . . . . . . . . . . . 22-73
LibBlockSrcSignalIsDiscrete(portIdx, sigIdx) . . . . . . . . . . . . . . . . 22-74

xxii Contents



LibBlockSrcSignalIsGlobalAndModifiable(portIdx, sigIdx) . . . . . . . 22-74
LibBlockSrcSignalIsInvariant(portIdx, sigIdx) . . . . . . . . . . . . . . . . 22-74
LibGetModelReferenceUserData(modelName) . . . . . . . . . . . . . . . 22-74
LibGetReferencedModelNames() . . . . . . . . . . . . . . . . . . . . . . . . . 22-74
LibIsModelReferenceRTWTarget() . . . . . . . . . . . . . . . . . . . . . . . . 22-75
LibIsModelReferenceSimTarget() . . . . . . . . . . . . . . . . . . . . . . . . . 22-75
LibIsModelReferenceTarget() . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-75

Block Compatibility Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-76
LibBlockSetIsExpressionCompliant(block) . . . . . . . . . . . . . . . . . . 22-76
LibBlockSetIntegerDowncastUnnecessary(block) . . . . . . . . . . . . . 22-76
LibBlockSetCustomStorageComplianceLevel (block, level) . . . . . . 22-76

TLC Error Handling
A

TLC Error Handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
Error Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
Generating Errors from TLC Files . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2
Using TLC Error Messages to Troubleshoot . . . . . . . . . . . . . . . . . . . A-4
%closefile or %selectfile or %flushfile argument must be a valid open
file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4

%define no longer supported, use %function instead . . . . . . . . . . . . A-4
%error directive: text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4
%exit directive: text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-4
%filescope has already been used in this file . . . . . . . . . . . . . . . . . . . A-4
%trace directive: text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-5
%warning directive: text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-5
A %implements directive must appear within a block template file and

must match the %language and type specified . . . . . . . . . . . . . . . A-5
A %switch statement can only have one %default . . . . . . . . . . . . . . . A-5
A language choice must be made using the %language directive prior

to using GENERATE or GENERATE_TYPE . . . . . . . . . . . . . . . . . . A-5
A non-homogeneous vector was passed to

GENERATE_FORMATTED_VALUE . . . . . . . . . . . . . . . . . . . . . . . . A-5
Ambiguous reference to identifier — must use array index to refer to

one of multiple scopes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-6
An %if statement can only have one %else . . . . . . . . . . . . . . . . . . . . A-6
Argument to identifier must be a string . . . . . . . . . . . . . . . . . . . . . . A-6
Arguments to directive must be records . . . . . . . . . . . . . . . . . . . . . . A-7
Arguments to TLC from the MATLAB command line must be strings

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-7
Assertion failed . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-7
Assignment to scope identifier is only allowed when using the +

operator to add members . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-7
Attempt to define a function identifier on top of an existing variable or

function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-7
Attempt to divide by zero . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-7
Bad cast - unable to cast this expression to type . . . . . . . . . . . . . . . . A-7
Bad directory (dirname) in O: filename . . . . . . . . . . . . . . . . . . . . . . . A-8
builtin was expecting expression of type type, got one of type type

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-8
Cannot %undef any builtin functions or variables . . . . . . . . . . . . . . . A-8

xxiii



Cannot convert string your_string to a number . . . . . . . . . . . . . . . . . A-8
Changing value of identifier from the RTW file . . . . . . . . . . . . . . . . . A-8
Error opening filename . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-8
Error writing to file error . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-8
Errors occurred — aborting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-8
Expansion directives %<> cannot be nested . . . . . . . . . . . . . . . . . . . A-8
Expansion directives %<> cannot span multiple lines; use \ at end of

line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-9
Extra arguments to the function-name built-in function were ignored

(Warning) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-9
File name too long (directory =dirname, name =filename) . . . . . . . . A-9
format is not a legal format value . . . . . . . . . . . . . . . . . . . . . . . . . . . A-9
Function argument mismatch; function function_name expects number

arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-9
Function reached the end and did not return a value . . . . . . . . . . . A-10
Function values are not allowed . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10
Identifier identifier multiply defined. Second and succeeding
definitions ignored. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10

Identifier identifier used on a %foreach statement was already in scope
(Warning) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10

Illegal use of eval (i.e., %<...>) . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10
Indices may not be negative . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10
Indices must be constant integral numbers . . . . . . . . . . . . . . . . . . . A-10
Invalid handle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10
Invalid identifier range, the leading strings string1 and string2 must

match . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-10
Invalid identifier range, the lower bound (bound) must be less than the

upper bound (bound) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11
Invalid type for unary operator . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11
Invalid type type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11
It is illegal to return a function from a function . . . . . . . . . . . . . . . . A-11
Named value identifier already exists within this scope-identifier; use

%assign to change the value . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11
No %case statement(s) seen yet, statement ignored . . . . . . . . . . . . A-11
Only double and character arrays can be converted from MATLAB to

TLC. This can occur if the MATLAB function does not return a value
(see %matlab) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-11

Only one output is allowed from the TLC . . . . . . . . . . . . . . . . . . . . A-12
Only strings of length 1 can be assigned using the [ ] notation . . . . A-12
Only strings or cells of strings may be used as the argument to Query

and ExecString . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-12
Only vectors of the same length as the existing vector value can be

assigned using the [ ] notation . . . . . . . . . . . . . . . . . . . . . . . . . . A-12
Output file identifier opened with %openfile was not closed . . . . . . A-12
Ranges, identifier ranges, and repeat values cannot be repeated . . A-12
String cannot modify the setting for the command line switch '-switch'

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-12
string is not a recognized user defined property of this handle . . . . A-12
Syntax error . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-13
The %break directive can only appear within a %foreach, %for, %roll,

or %switch statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-13
The %case and %default directives can only be used within the

%switch statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-13
The %continue directive can only appear within a %foreach, %for, or

%roll statement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-13
The %foreach statement expects a constant numeric argument . . . A-13

xxiv Contents



The %if statement expects a constant numeric argument . . . . . . . . A-13
The %implements directive expects a string or string vector as the list

of languages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-13
The %implements directive specifies type as the type where type was

expected . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-14
The %implements language does not match the language currently

being generated (language) . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-14
The %return statement can only appear within the body of a function

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-14
The == and != operators can only be used to compare values of the

same type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-14
The argument for %openfile must be a valid string . . . . . . . . . . . . . A-14
The argument for %with must be a valid scope . . . . . . . . . . . . . . . . A-14
The argument for an [ ] operation must be a repeated scope symbol, a

vector, or a matrix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-14
The argument to %addincludepath must be a valid string . . . . . . . . A-15
The argument to %include must be a valid string . . . . . . . . . . . . . . A-15
The begin directive must be in the same file as the corresponding end

directive. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-15
The begin directive on this line has no matching end directive . . . . A-15
The construct %matlab function_name(...) construct is illegal in

standalone tlc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-15
The FEVAL() function can accept only 2-dimensional arrays from

MATLAB, not number dimensions . . . . . . . . . . . . . . . . . . . . . . . . A-16
The FEVAL() function can accept vectors of numbers or strings only

when calling MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-16
The FEVAL() function requires the name of a function to call . . . . . A-16
The final argument to %roll must be a valid block scope . . . . . . . . . A-16
The first argument of a ? : operator must be a Boolean expression . A-16
The first argument to GENERATE or GENERATE_TYPE must be a valid

scope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-16
The function name requires at least number arguments . . . . . . . . . A-16
The GENERATE function requires at least 2 arguments . . . . . . . . . A-16
The GENERATE_TYPE function requires at least 3 arguments . . . . A-16
The ISINF(), ISNAN(), ISFINITE(), REAL(), and IMAG() functions

expect a real or complex valued argument . . . . . . . . . . . . . . . . . A-17
The language being implemented cannot be changed within a block

template file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-17
The language being implemented has changed from old-language to

new-language (Warning) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-17
The left-hand side of a . operator must be a valid scope identifier . . A-17
The left-hand side of an assignment must be a simple expression

comprised of ., [ ], and identifiers . . . . . . . . . . . . . . . . . . . . . . . . A-17
The number of columns specified (specified-columns) did not match

the actual number of columns in the rows (actual-columns) . . . . A-17
The number of rows specified (specified-rows) did not match the actual

number of rows seen in the matrix (actual-rows) . . . . . . . . . . . . A-17
The operator_name operator only works on Boolean arguments . . . A-18
The operator_name operator only works on integral arguments . . . A-18
The operator_name operator only works on numeric arguments . . . A-18
The return value from the RollHeader function must be a string . . . A-18
The roll argument to %roll must be a nonempty vector of numbers or

ranges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-18
The second value in a Range must be greater than the first value . . A-18
The specified index (index) was out of the range 0 - number-of-

elements - 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-18

xxv



The STRINGOF built-in function expects a vector of numbers as its
argument . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19

The SYSNAME built-in function expects an input string of the form
xxx/yyy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19

The threshold on a %roll statement must be a single number . . . . . A-19
The use of feature is being deprecated and will not be supported in

future versions of TLC. See the TLC manual for alternatives. . . . A-19
The WILL_ROLL built in function expects a range vector and an

integer threshold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19
There are no more free contexts. Use tlc('close', HANDLE) to free up a

context . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19
There was no type associated with the given block for GENERATE

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-19
This assignment would overwrite an identifier-value pair from the RTW
file. To avoid this error either qualify the left-hand side, or choose
another identifier. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-20

TLC has leaked number symbols. You may have created a cyclic
record. If this not the case then please report this leak to The
MathWorks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-20

Unable to find identifier within the scope-identifier scope . . . . . . . . A-20
Unable to open %include file filename . . . . . . . . . . . . . . . . . . . . . . A-20
Unable to open block template file filename from GENERATE or

GENERATE_TYPE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-20
Unable to open output file filename . . . . . . . . . . . . . . . . . . . . . . . . A-21
Undefined identifier identifier_name . . . . . . . . . . . . . . . . . . . . . . . . A-21
Unknown type type in CAST expression . . . . . . . . . . . . . . . . . . . . . A-21
Unrecognized command line switch passed to string: switch . . . . . A-21
Unrecognized directive directive-name seen . . . . . . . . . . . . . . . . . . A-21
Unrecognized type output-type for function . . . . . . . . . . . . . . . . . . A-22
Unterminated multiline comment. . . . . . . . . . . . . . . . . . . . . . . . . . A-22
Unterminated string . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-22
Usage: tlc [options] file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-22
Use of feature incurs a performance hit, please see TLC manual for

possible workarounds. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-22
Value of type type cannot be compared . . . . . . . . . . . . . . . . . . . . . . A-22
Values of specified_type type cannot be expanded . . . . . . . . . . . . . . A-22
Values of type Special, Macro Expansion, Function, File, Full Identifier,

and Index cannot be converted to MATLAB variables . . . . . . . . . A-23
When appending to a buffer stream, the variable must be a string . A-23
TLC Function Library Error Messages . . . . . . . . . . . . . . . . . . . . . . A-23

Guidelines and Standards for Embedded Coder
23

Support for Standards and Guidelines . . . . . . . . . . . . . . . . . . . . . . . 23-2

MAB Guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-4

MISRA C Guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-5

Secure Coding Standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-6

xxvi Contents



High-Integrity System Modeling Guidelines . . . . . . . . . . . . . . . . . . . 23-7

Modeling Guidelines for Code Generation . . . . . . . . . . . . . . . . . . . . 23-8

IEC 61508 Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-9
Apply Simulink and Embedded Coder to the IEC 61508 Standard

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-9
Check for IEC 61508 Standard Compliance Using the Model Advisor

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-9
Validate Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-9

IEC 62304 Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-11
Apply Simulink and Embedded Coder to the IEC 62304 Standard

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-11
Check for IEC 62304 Standard Compliance Using the Model Advisor

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-11

ISO 26262 Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-12
Apply Simulink and Embedded Coder to the ISO 26262 Standard

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-12
Check for ISO 26262 Standard Compliance Using the Model Advisor

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-12
Validate Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-12

EN 50128 Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-13
Apply Simulink and Embedded Coder to the EN 50128 Standard . 23-13
Check for EN 50128 Standard Compliance Using the Model Advisor

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-13
Validate Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-13

ISO 25119 Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-14
Apply Simulink and Embedded Coder to the ISO 25119 Standard

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-14
Validate Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-14

DO-178C Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-15
Apply Simulink and Embedded Coder to the DO-178C Standard . . 23-15
Check for Standard Compliance Using the Model Advisor . . . . . . . 23-15
Validate Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-15

AUTOSAR Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-17
Check for AUTOSAR Standard Compliance Using the Model Advisor

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-17

Develop a Model that Complies with the AUTOSAR Standard . . . . 23-18

Develop a Model that Complies with the IEC 61508 Standard . . . 23-24

xxvii



MISRA C:2012 Compliance and Deviations for Code
Generated by Using Embedded Coder

24
Developing a MISRA C:2012 Compliance Statement . . . . . . . . . . . . 24-2

MathWorks Process for Identifying Violations of MISRA C:2012
Guidelines in Generated C Code . . . . . . . . . . . . . . . . . . . . . . . . . 24-2

Evaluate Your Generated Code for MISRA C:2012 Compliance . . . . 24-4

MISRA C:2012 Compliance Information Summary Tables . . . . . . . . 24-6
Compliance Summary Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-6
Explanatory Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-15

Modeling Guidelines for MISRA C:2012 Compliance . . . . . . . . . . . 24-18
High-Integrity System Modeling Guidelines for MISRA C:2012

Compliance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-18
MISRA C:2012 Rationale for Model Advisor Checks . . . . . . . . . . . 24-20

Deviations Rationale for MISRA C:2012 Compliance . . . . . . . . . . . 24-25
MISRA C:2012 Directive 4.7 Deviation Rationale . . . . . . . . . . . . . 24-25
MISRA C:2012 Rule 13.5 Deviation Rationale . . . . . . . . . . . . . . . . 24-28

Patterns for C Code in Embedded Coder
25

Prepare a Model for Code Generation . . . . . . . . . . . . . . . . . . . . . . . . 25-2
Configure Input Ports, Output Ports, and Arbitrary Signals . . . . . . . 25-2
Initialize and Configure States . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-2
Set Up Configuration Parameters for Code Generation . . . . . . . . . . 25-2
Set Up an Example Model With a Stateflow Chart . . . . . . . . . . . . . . 25-3
Set Up an Example Model With a MATLAB Function Block . . . . . . . 25-4

Definition, Initialization, and Declaration of Parameter Data . . . . . 25-5

Definition and Declaration of Signal Data . . . . . . . . . . . . . . . . . . . . . 25-7

Data Type Conversion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-9

Type Qualifiers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-12

Relational and Logical Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-14

Bitwise Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-17

Enumeration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-20

If-Else . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-23

Switch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-27

xxviii Contents



For Loop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-31

While Loop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-35

Do While Loop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-40

Function Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-43

Function Prototyping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-45

External C Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-48

Macro Definitions (#define) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-54

Conditional Inclusions (#if / #endif) . . . . . . . . . . . . . . . . . . . . . . . . 25-56

Typedef . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-57

Structures of Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-59

Structures of Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-62

Nested Structures of Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-64

Bitfields . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-68

Arrays for Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-70

Arrays for Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-71

Pointers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-73

Variant Systems in Embedded Coder
26

Implement Dimension Variants for Array Sizes in Generated Code
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-2

Dimension Variants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-2
Set Parameter Value Based on Variant Choice . . . . . . . . . . . . . . . . . 26-9
Code Generation Optimization Considerations . . . . . . . . . . . . . . . 26-10
Backward Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-11
Supported Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-11
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-12

Code Generation for Variant Blocks . . . . . . . . . . . . . . . . . . . . . . . . 26-15
Restrictions on Variant Subsystem Code Generation . . . . . . . . . . . 26-15
Generated Code Components Not Compiled Conditionally . . . . . . 26-16
Code Generation for Variant Blocks with One Variant Choice . . . . 26-17
Global Data Guarding: Signals and States . . . . . . . . . . . . . . . . . . . 26-18
Global Data Guarding: Parameters . . . . . . . . . . . . . . . . . . . . . . . . 26-19
Guarding Reference Model Headers . . . . . . . . . . . . . . . . . . . . . . . 26-19

xxix



Represent Subsystem and Variant Models in Generated Code . . . 26-21
Step 1: Represent Variant Choices in Simulink . . . . . . . . . . . . . . . 26-21
Step 2: Specify Conditions That Control Variant Choice Selection

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-24
Step 3: Configure Model for Generating Preprocessor Conditionals

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-26
Step 4: Review Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . 26-27
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-30

Generate Preprocessor Conditionals for Variant Systems . . . . . . . 26-31
Define Variant Controls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-31
Configure Model for Generating Preprocessor Conditional Directives

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-32
Special Considerations for Generating Preprocessor Conditionals

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-32
Generate Variant Control Macros in Same Header File . . . . . . . . . 26-33

Represent Variant Source and Sink Blocks in Generated Code . . . 26-36
Represent Variant Source and Variant Sink Blocks in Simulink . . . 26-36
Specify Conditions That Control Variant Choice Selection . . . . . . . 26-39
Review the Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-40
Generate Code with Zero Active Variant Controls . . . . . . . . . . . . . 26-42

Configure Dimension Variants for S-Function Blocks . . . . . . . . . . 26-44
S-Function That Supports Forward Propagation of Symbolic

Dimensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-45
S-Function That Supports Forward and Backward Propagation of

Symbolic Dimensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-49

Represent Variant Condition Values of Enumerated Type in
Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-51

Use Enumerated Type Derived From Built-In Integer . . . . . . . . . . 26-51
Use In-Memory Enumerated Type Derived From

Simulink.IntEnumType . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-54

Options to Represent Variant Parameters in Generated Code . . . . 26-55
Overview of Variant Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 26-55
Choice of Values in Generated Code . . . . . . . . . . . . . . . . . . . . . . . 26-55
Types of Variables in Generated Code . . . . . . . . . . . . . . . . . . . . . . 26-55
Generate C Code for Variant Parameters . . . . . . . . . . . . . . . . . . . 26-56

Generate Code for Variant Subsystem with Child Subsystems of
Different Output Signal Dimensions . . . . . . . . . . . . . . . . . . . . . . 26-60

Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-60
Simulate Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-60
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-61

Use Variant Subsystem To Generate Code That Uses C Preprocessor
Conditionals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-63

Use Variant Models to Generate Code That Uses C Preprocessor
Conditionals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-68

xxx Contents



Timers in Simulink Coder
27

Absolute and Elapsed Time Computation . . . . . . . . . . . . . . . . . . . . . 27-2
About Timers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-2
Timers for Periodic and Asynchronous Tasks . . . . . . . . . . . . . . . . . . 27-2
Allocation of Timers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-2
Integer Timers in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . 27-3
Elapsed Time Counters in Triggered Subsystems . . . . . . . . . . . . . . 27-3

Access Timers Programmatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-4
About Timer APIs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-4
C API for S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-4
TLC API for Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-6

Generate Code for an Elapsed Time Counter . . . . . . . . . . . . . . . . . . 27-7

Absolute Time Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-10

Time-Based Scheduling in Simulink Coder
28

Time-Based Scheduling and Code Generation . . . . . . . . . . . . . . . . . 28-2
Sample Time Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-2
Tasking Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-2
Model Execution and Rate Transitions . . . . . . . . . . . . . . . . . . . . . . 28-3
Execution During Simulink Model Simulation . . . . . . . . . . . . . . . . . 28-4
Model Execution in Real Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-4
Single-Tasking Versus Multitasking Operation . . . . . . . . . . . . . . . . . 28-4

Modeling for Single-Tasking Execution . . . . . . . . . . . . . . . . . . . . . . . 28-6
Single-Tasking Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-6
Build a Program for Single-Tasking Execution . . . . . . . . . . . . . . . . . 28-6
Single-Tasking Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-6

Modeling for Multitasking Execution . . . . . . . . . . . . . . . . . . . . . . . . 28-9
Multitasking and Pseudomultitasking Modes . . . . . . . . . . . . . . . . . 28-9
Build a Program for Multitasking Execution . . . . . . . . . . . . . . . . . 28-11
Execute Multitasking Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-11
Multitasking Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-12

Handle Rate Transitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-16
Rate Transitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-16
Data Transfer Problems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-17
Data Transfer Assumptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-17
Rate Transition Block Options . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-18
Automatic Rate Transition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-19
Visualize Inserted Rate Transition Blocks . . . . . . . . . . . . . . . . . . . 28-20
Periodic Sample Rate Transitions . . . . . . . . . . . . . . . . . . . . . . . . . 28-22
Protect Data Integrity with volatile Keyword . . . . . . . . . . . . . . . . . 28-26

xxxi



Separate Rate Transition Block Code and Data from Algorithm Code
and Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-26

Configure Time-Based Scheduling . . . . . . . . . . . . . . . . . . . . . . . . . . 28-33
Configure Start and Stop Times . . . . . . . . . . . . . . . . . . . . . . . . . . 28-33
Configure the Solver Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-33
Configure the Tasking Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-33

Time-Based Scheduling Example Models . . . . . . . . . . . . . . . . . . . . 28-35
Optimize Memory Usage for Time Counters . . . . . . . . . . . . . . . . . 28-35
Single-Rate Modeling (Bare Board, No OS) . . . . . . . . . . . . . . . . . . 28-40
Multirate Modeling in Single-Tasking Mode (Bare Board, no OS) . 28-41
Multirate Modeling in Multitasking Mode (Bare Board, no OS) . . . 28-41
Multirate Modeling in Multitasking Mode (VxWorks® OS) . . . . . . 28-43
Trade Determinism and Data Integrity to Improve System Performance

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-43

Event-Based Scheduling in Simulink Coder
29

Asynchronous Events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-2
Asynchronous Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-2
Block Library for Calls to an Example Real-Time Operating System

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-2
Access the Block Library for RTOS Integration . . . . . . . . . . . . . . . . 29-3
Generate Code Using Library Blocks for RTOS Integration . . . . . . . 29-3
Examples and Additional Information . . . . . . . . . . . . . . . . . . . . . . . 29-3

Generate Interrupt Service Routines . . . . . . . . . . . . . . . . . . . . . . . . . 29-5
Connecting the Async Interrupt Block . . . . . . . . . . . . . . . . . . . . . . . 29-5
Requirements and Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-5
Performance Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-6
Using the Async Interrupt Block in Simulation and Code Generation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-6
Dual-Model Approach: Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . 29-7
Dual-Model Approach: Code Generation . . . . . . . . . . . . . . . . . . . . . 29-7

Spawn and Synchronize Execution of RTOS Task . . . . . . . . . . . . . . 29-11

Pass Asynchronous Events in RTOS as Input To a Referenced Model
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-28

Rate Transitions and Asynchronous Blocks . . . . . . . . . . . . . . . . . . 29-35
About Rate Transitions and Asynchronous Blocks . . . . . . . . . . . . . 29-35
Handle Rate Transitions for Asynchronous Tasks . . . . . . . . . . . . . 29-36
Handle Multiple Asynchronous Interrupts . . . . . . . . . . . . . . . . . . . 29-36
Protect Data Integrity with volatile Keyword . . . . . . . . . . . . . . . . . 29-38

Timers in Asynchronous Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-39

Create a Customized Asynchronous Library . . . . . . . . . . . . . . . . . . 29-41
About Implementing Asynchronous Blocks . . . . . . . . . . . . . . . . . . 29-41

xxxii Contents



Async Interrupt Block Implementation . . . . . . . . . . . . . . . . . . . . . 29-41
Task Sync Block Implementation . . . . . . . . . . . . . . . . . . . . . . . . . 29-44
asynclib.tlc Support Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-46

Import Asynchronous Event Data for Simulation . . . . . . . . . . . . . . 29-48
Capabilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-48
Input Data Format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-48
Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-48

Asynchronous Support Limitations . . . . . . . . . . . . . . . . . . . . . . . . . 29-51
Asynchronous Task Priority . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-51
Convert an Asynchronous Subsystem into a Model Reference . . . . 29-51

Scheduling Considerations in Embedded Coder
30

Use Discrete and Continuous Time . . . . . . . . . . . . . . . . . . . . . . . . . . 30-2
Support for Discrete and Continuous Time Blocks . . . . . . . . . . . . . . 30-2
Support for Continuous Solvers . . . . . . . . . . . . . . . . . . . . . . . . . . . 30-2
Support for Stop Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30-2

Optimize Multirate Multitasking Execution for RTOS Run-Time
Environments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30-4

Use rtmStepTask . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30-4
Schedule Code for Real-time Model without an RTOS . . . . . . . . . . . 30-4
Schedule Code for Multirate Multitasking on an RTOS . . . . . . . . . . 30-5
Suppress Redundant Scheduling Calls . . . . . . . . . . . . . . . . . . . . . . 30-5

Representing a Software Architecture by Creating Code
Generation Definitions

31
Define Storage Classes, Memory Sections, and Function Templates

for Software Architecture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-2
Create Code Definitions for Use in the Code Mappings Editor . . . . . 31-2
Create Code Definitions for External Data Objects . . . . . . . . . . . . . 31-2
Use Package Code Definitions in Embedded Coder Dictionaries . . . 31-3
Constrain Use of Storage Class Code Mappings . . . . . . . . . . . . . . . 31-3
Deploy Code Generation Definitions to Users . . . . . . . . . . . . . . . . . 31-3
Interact with Code Generation Definitions Programmatically . . . . . 31-3

Create Code Definitions Programmatically . . . . . . . . . . . . . . . . . . . . 31-5

Deploy Code Generation Definitions . . . . . . . . . . . . . . . . . . . . . . . . 31-10
Share Code Generation Definitions Between Multiple Models and

Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-10
Dictionary Usage for Models Created with Different Versions of

Simulink . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-10
Configure Default Code Mapping in a Shared Dictionary . . . . . . . . 31-10

xxxiii



Share Embedded Coder Dictionary Definition Between Models . . . 31-12
Migrate Definitions from Model File to Shared Data Dictionary . . 31-14
Use Data Dictionary to Store Code Definitions but Not Design Data

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-16

Generate Code to Conform to Software Architecture by Sharing and
Copying Default Settings Between Models . . . . . . . . . . . . . . . . . 31-18

Share Common Code Generation Settings among Multiple Models
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-18

Copy Code Generation Settings to New Models . . . . . . . . . . . . . . 31-19

Manage an Embedded Coder Dictionary . . . . . . . . . . . . . . . . . . . . . 31-21
Share Available Code Definitions with New Models . . . . . . . . . . . . 31-21
Migrate Package Definitions to Embedded Coder Dictionary to Use in

Code Mappings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-21
Change Code Generation Definitions . . . . . . . . . . . . . . . . . . . . . . 31-22

Migration of Memory Section and Shared Utility Settings from
Configuration Parameters to Code Mappings . . . . . . . . . . . . . . . 31-25
Effects of Migration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-25
Considerations Before Migrating . . . . . . . . . . . . . . . . . . . . . . . . . 31-25
Considerations After Migrating . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-26

Flexible Storage Class for Different Model Hierarchy Contexts . . 31-28

Separation of Code Definitions from Model-Specific Data and
Function Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31-31

Manage Code Specifications in One Location . . . . . . . . . . . . . . . . 31-31
Apply Definitions to Model Elements with Flexibility . . . . . . . . . . . 31-31
Generate Standardized Code from Multiple Models . . . . . . . . . . . 31-32
Generate Code for Different Platforms . . . . . . . . . . . . . . . . . . . . . 31-33

Message-Based Communication
32

Generate C Messages to Communicate Between Simulink
Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-2

How to Prepare Models in Simulink for Message-Based
Communication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-2

How Model Components Pass Messages and How the Code
Implements this Behavior . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-2

C Code Generation Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-3
Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-6

Generate C++ Messages to Communicate Between Simulink
Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-8

How to Prepare Models in Simulink for Message-Based
Communication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-8

How Model Components Pass Messages and How the Code
Implements this Behavior . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-8

C++ Code Generation Example . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-9
Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-12

xxxiv Contents



Generate C++ Messages to Communicate Between Simulink and an
Operating System or Middleware . . . . . . . . . . . . . . . . . . . . . . . . . 32-13

Prepare Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-13
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-14
Integrate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-14
Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . 32-17

Use Handwritten Code to Integrate C++ Messages with POSIX . . 32-18

Data, Function, and File Definition

Configuring Data and Functions in the Generated Code
33

C Code Generation Configuration for Model Interface Elements
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-2

Migration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-2
Code Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-3
Data Default Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-3
Function Default Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-6
Configurations for Individual Data Elements and Functions . . . . . . 33-8
Configure Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-9
Configure Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-10

Code Definition and Mapping Limitations and Considerations . . . 33-11
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-11
Default Code Mapping Constraints . . . . . . . . . . . . . . . . . . . . . . . . 33-11
Unresolved Code Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-12
Model Editing Operations and Individual Data Element Code Mappings

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-12
Storage Classes and Reentrant, Multi-Instance Models and

Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-13
Copy Code Mappings When Converting Subsystems to Referenced

Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-14

Configure Default C Code Generation for Categories of Data
Elements and Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-15

Set Up Example Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-15
Configure Default Code Generation for Data . . . . . . . . . . . . . . . . . 33-16
Configure Default Code Generation for Functions . . . . . . . . . . . . . 33-20
Configure Model Elements for Code Generation with Definitions

Stored in Shared Data Dictionary . . . . . . . . . . . . . . . . . . . . . . . 33-22
Configure Default Data and Function Code Generation

Programmatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-24

Configure Root-Level Inport Blocks for C Code Generation . . . . . 33-30
Choose Customization Options for Inport Interface . . . . . . . . . . . . 33-30
Configure Default Code Generation Settings for Root-Level Inports

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-31

xxxv



Configure Code Generation Settings for Individual Root-Level Inports
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-33

Configure Code Generation Settings for Root-Level Inports
Programmatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-36

Choose Storage Class and Storage Class Properties for Root-Level
Inports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-39

Configure Root-Level Outport Blocks for C Code Generation . . . . 33-42
Choose Customization Options for Outport Interface . . . . . . . . . . 33-42
Configure Default Code Generation Settings for Root-Level Outports

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-43
Configure Code Generation Settings for Individual Root-Level Outports

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-45
Configure Code Generation Settings for Root-Level Outports

Programmatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-47
Choose Storage Class and Storage Class Properties for Root-Level

Outports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-48

Configure Signal Data for C Code Generation . . . . . . . . . . . . . . . . 33-51
Choose Code Configuration Options for Signals . . . . . . . . . . . . . . 33-51
Add Signals to Model Code Mappings . . . . . . . . . . . . . . . . . . . . . . 33-52
Configure Default Code Generation Settings for Signals . . . . . . . . 33-54
Configure Code Generation Settings for Individual Signals . . . . . . 33-55
Remove Signals from Model Code Mappings . . . . . . . . . . . . . . . . . 33-57
Configure Code Generation Settings for Signals Programmatically

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-57
Choose Storage Class and Storage Class Properties for Signals . . 33-59

Configure Parameters for C Code Generation . . . . . . . . . . . . . . . . . 33-62
Choose Customization Options for Parameters . . . . . . . . . . . . . . . 33-63
Configure Default Code Generation Settings for Parameters . . . . . 33-64
Configure Code Generation for Individual Parameters . . . . . . . . . 33-66
Organize Parameter Data into a Structure by Using Struct Storage

Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-68
Configure Code Generation Settings for Parameters Programmatically

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-70
Choose Storage Class and Storage Class Properties for Model

Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-72

Configure Block States for C Code Generation . . . . . . . . . . . . . . . . 33-75
Choose Code Configuration Options for States . . . . . . . . . . . . . . . 33-75
Configure Default Code Generation Settings for States . . . . . . . . . 33-76
Configure Code Generation Settings for Individual States . . . . . . . 33-77
Configure Code Generation Settings for States Programmatically

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-79
Choose Storage Class and Storage Class Properties for States . . . 33-80

Configure Data Stores for C Code Generation . . . . . . . . . . . . . . . . 33-83
Choose Customization Options for Data Stores . . . . . . . . . . . . . . . 33-83
Configure Default Code Generation Settings for Data Stores . . . . . 33-84
Configure Code Generation for Individual Data Stores . . . . . . . . . 33-86
Configure Code Generation Settings for Data Stores Programmatically

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-88
Choose Storage Class and Storage Class Properties for Data Stores

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-90

xxxvi Contents



Manage Multiple Code Mappings for a Model . . . . . . . . . . . . . . . . 33-92
Configure Alternative Code Mappings by Using Configuration Sets

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-92
Activate Code Mappings in the Simulink Editor . . . . . . . . . . . . . . 33-93
Create and Activate Code Mappings Programmatically . . . . . . . . . 33-93
Code Mappings and Embedded Coder Dictionary . . . . . . . . . . . . . 33-94

Configure Model Data Interface for C Code Generation . . . . . . . . 33-95

Migration of Model Data Configurations to Code Mappings . . . . 33-102
Effects of Migration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-102
Considerations Before Migrating . . . . . . . . . . . . . . . . . . . . . . . . 33-103
Copy Blocks and Signal Lines Between Models . . . . . . . . . . . . . . 33-106
Switch Between GRT- and ERT-Based System Target Files . . . . . . 33-107
Workflow Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-108

Dimension Preservation of Multidimensional Arrays . . . . . . . . . . 33-109
Dimension Preservation in Generated Code . . . . . . . . . . . . . . . . 33-109
Difference in Dimension Preservation Between MATLAB and C . . 33-109

Configure C Code Generation for Model Entry-Point Functions 33-112
What Is an Entry-Point Function? . . . . . . . . . . . . . . . . . . . . . . . . 33-112
Types of Generated Entry-Point Functions . . . . . . . . . . . . . . . . . 33-112
Configure Whether Entry-Point Functions Are Reusable . . . . . . . 33-114
Choose an Approach for Configuring Generated C Function Interfaces

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-116
Configure Default Code Generation Settings for a Function Category

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-116
Configure Names for Individual C Entry-Point Functions . . . . . . . 33-117
Configure Name and Arguments for Individual Step Functions . . 33-118
Configure Code Generation Settings for C Entry-Point Functions

Programmatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-126
How to Interface with Generated Entry-Point Functions . . . . . . . 33-127
C Function Interface Customization Limitations . . . . . . . . . . . . . 33-127

Configure Multi-Instance Code Generation . . . . . . . . . . . . . . . . . 33-129
Configure a Top Model for Multi-Instance Code Generation . . . . 33-129
Configure a Referenced Model for Multi-Instance Code Generation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-129

Configure Data Interfaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-130
Configure Default Code Generation for Data . . . . . . . . . . . . . . . . 33-130
Override Default Data Interface for Individual Data Elements . . . 33-130

Configure Entry-Point Function Interfaces . . . . . . . . . . . . . . . . . . 33-131
Define Function Customization Templates . . . . . . . . . . . . . . . . . 33-131
Configure Default Code Generation for Entry-Point Functions . . . 33-131
Override Default Code Generation for Entry-Point Functions . . . 33-131

Configure Internal Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-133
Configure Default Representation of Internal Data . . . . . . . . . . . 33-133
Override Default Representation for Individual Internal Data Elements

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33-133

Configure Subsystem Function Packaging and Interface . . . . . . 33-134

xxxvii



Data Representation in Simulink Coder
34

Preserve Variables in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . 34-2
Access Signal, State, and Parameter Data During Execution . . . . . . 34-2
Configure Data Accessibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-15
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-16

Access Signal, State, and Parameter Data During Execution . . . . 34-17

Data Structures in the Generated Code . . . . . . . . . . . . . . . . . . . . . . 34-31
Standard Data Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-31
Real-Time Model Data Structure . . . . . . . . . . . . . . . . . . . . . . . . . . 34-32

How Generated Code Exchanges Data with an Environment . . . . . 34-35
Data Interfaces in the Generated Code . . . . . . . . . . . . . . . . . . . . . 34-35
Configure Data Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-42

Control Data and Function Interface in Generated Code . . . . . . . . 34-44
Control Type Names, Field Names, and Variable Names of Standard

I/O Structures (Embedded Coder) . . . . . . . . . . . . . . . . . . . . . . . 34-44
Control Names of Generated Entry-Point Functions (Embedded Coder)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-44
Control Data Interface for Nonreentrant Code . . . . . . . . . . . . . . . 34-44
Control Data Interface for Reentrant Code . . . . . . . . . . . . . . . . . . 34-46
Prevent Unintended Changes to the Interface . . . . . . . . . . . . . . . . 34-46
Reduce Number of Arguments by Using Structures . . . . . . . . . . . 34-47
Control Data Types of Arguments . . . . . . . . . . . . . . . . . . . . . . . . . 34-48
Promote Data Item to the Interface . . . . . . . . . . . . . . . . . . . . . . . . 34-48

How Generated Code Stores Internal Signal, State, and Parameter
Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-49

Internal Data in the Generated Code . . . . . . . . . . . . . . . . . . . . . . 34-49
Local Variables in the Generated Code . . . . . . . . . . . . . . . . . . . . . 34-64
Appearance of Test Points in the Generated Code . . . . . . . . . . . . . 34-64
Appearance of Workspace Variables in the Generated Code . . . . . 34-64
Promote Internal Data to the Interface . . . . . . . . . . . . . . . . . . . . . 34-65
Control Default Representation of Internal Data (Embedded Coder)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-67

Choose Data Configuration Approach . . . . . . . . . . . . . . . . . . . . . . . 34-69
Data Element Categories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-69
Where to Store Data Elements Used by Your Model . . . . . . . . . . . 34-70
When to Configure a Data Element for Code Generation . . . . . . . . 34-70
Configure a Data Element for Code Generation . . . . . . . . . . . . . . . 34-71

Choose Storage Class for Controlling Data Representation in
Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-74

Storage Class Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-74
Default Storage Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-74
Built-in and Predefined Storage Classes . . . . . . . . . . . . . . . . . . . . 34-74
Auto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-76
Default . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-76
Model Default . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-76

xxxviii Contents



Dictionary Default . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-76
ExportedGlobal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-77
ImportedExtern, ImportedExternPointer . . . . . . . . . . . . . . . . . . . . 34-77
Bitfield . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-77
CompilerFlag . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-78
Const, Volatile, and ConstVolatile . . . . . . . . . . . . . . . . . . . . . . . . . 34-78
Define, ImportedDefine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-79
ExportToFile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-79
FileScope . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-80
GetSet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-80
ImportFromFile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-80
Localizable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-81
Reusable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-81
Struct . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-82
ParamStruct, SignalStruct . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-82
Storage Class Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-82

Use Enumerated Data in Generated Code . . . . . . . . . . . . . . . . . . . . 34-84
Enumerated Data Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-84
Specify Integer Data Type for Enumeration . . . . . . . . . . . . . . . . . 34-84
Customize Enumerated Data Type . . . . . . . . . . . . . . . . . . . . . . . . 34-85
Control Enumerated Type Implementation in Generated Code . . . 34-89
Type Casting for Enumerations . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-90
Enumerated Type Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-90

Data Stores in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-92
About Data Stores . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-92
Generate Code for Data Store Memory Blocks . . . . . . . . . . . . . . . 34-92
Storage Classes for Data Store Memory Blocks . . . . . . . . . . . . . . . 34-93
Data Store Buffering in Generated Code . . . . . . . . . . . . . . . . . . . . 34-94
Data Stores Shared by Instances of a Reusable Model . . . . . . . . . 34-97
Structures in Generated Code Using Data Stores . . . . . . . . . . . . . 34-97

Specify Single-Precision Data Type for Embedded Application . . 34-101
Use single Data Type as Default for Underspecified Types . . . . . 34-101

Tune Phase Parameter of Sine Wave Block During Code Execution
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-104

Switch Between Output Waveforms During Code Execution for
Waveform Generator Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-106

Create Tunable Calibration Parameter in the Generated Code . . 34-109
Represent Block Parameter as Tunable Global Variable . . . . . . . 34-109
Apply Storage Class When Block Parameter Refers to Numeric

MATLAB Variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-112
Create Storage Class That Represents Calibration Parameters

(Embedded Coder) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-112
Initialize Parameter Value From System Constant or Other Macro

(Embedded Coder) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-116
Code Generation Impact of Storage Location for Parameter Objects

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-116
Configure Accessibility of Signal Data . . . . . . . . . . . . . . . . . . . . 34-117
Programmatic Interfaces for Tuning Parameters . . . . . . . . . . . . . 34-117
Set Tunable Parameter Minimum and Maximum Values . . . . . . . 34-117

xxxix



Considerations for Other Modeling Goals . . . . . . . . . . . . . . . . . . 34-118

Limitations for Block Parameter Tunability in Generated Code 34-120
Tunable Expression Limitations . . . . . . . . . . . . . . . . . . . . . . . . . 34-120
Linear Block Parameter Tunability . . . . . . . . . . . . . . . . . . . . . . . 34-121
Parameter Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-121

Code Generation of Parameter Objects With Expression Values 34-123
Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . 34-123
Expression Preservation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-123

Configure Packaging of Parameter Arguments in Generated Code
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-125

Code Generation Behavior . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-125
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-128

Parameter Data Types in the Generated Code . . . . . . . . . . . . . . . 34-129
Significance of Parameter Data Types . . . . . . . . . . . . . . . . . . . . . 34-129
Typecasts Due to Parameter Data Type Mismatches . . . . . . . . . . 34-129
Considerations for Other Modeling Patterns . . . . . . . . . . . . . . . . 34-130

Generate Efficient Code by Specifying Data Types for Block
Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-133

Eliminate Unnecessary Typecasts and Shifts by Matching Data Types
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-133

Reduce Memory Consumption by Storing Parameter Value in Small
Data Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-135

Reuse Parameter Data in Different Data Type Contexts . . . . . . . 34-141

Organize Data into Structures in Generated Code . . . . . . . . . . . . 34-145
Techniques to Create Structures . . . . . . . . . . . . . . . . . . . . . . . . . 34-148
Default Application of Structured Storage Class . . . . . . . . . . . . . 34-149
Direct Application of Structured Storage Class . . . . . . . . . . . . . . 34-150
Nonvirtual Buses and Parameter Structures . . . . . . . . . . . . . . . . 34-150
Combine Techniques to Work Around Limitations . . . . . . . . . . . . 34-157
Arrays of Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-158
Structure Padding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-158
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-158

Switch Between Sets of Parameter Values During Simulation and
Code Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-159

Design Data Interface by Configuring Inport and Outport Blocks
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-167

Generate Efficient Code for Bus Signals . . . . . . . . . . . . . . . . . . . . 34-171
Code Efficiency for Bus Signals . . . . . . . . . . . . . . . . . . . . . . . . . 34-171
Set Bus Diagnostics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-171
Optimize Virtual and Nonvirtual Buses . . . . . . . . . . . . . . . . . . . . 34-172

Control Signal and State Initialization in the Generated Code . . 34-174
Signal and State Initialization in the Generated Code . . . . . . . . . 34-174
Generate Tunable Initial Conditions . . . . . . . . . . . . . . . . . . . . . . 34-175
Generate Tunable Initial Condition Structure for Bus Signal . . . . 34-179

xl Contents



Initialization of Signal, State, and Parameter Data in the Generated
Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-185

Static Initialization and Dynamic Initialization . . . . . . . . . . . . . . 34-185
Real-World Ground Initialization Requiring Nonzero Bit Pattern . 34-185
Initialization of Signal and State Data . . . . . . . . . . . . . . . . . . . . . 34-186
Initialization of Parameter Data . . . . . . . . . . . . . . . . . . . . . . . . . 34-187
Data Initialization in the Generated Code . . . . . . . . . . . . . . . . . . 34-187
Modeling Goals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-192

Optimize Speed and Size of Signal Processing Algorithm by Using
Fixed-Point Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-194

Optimize Generated Code Using Fixed-Point Data with Simulink®,
Stateflow®, and MATLAB® . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-195

Declare Workspace Variables as Tunable Parameters Using the Model
Parameter Configuration Dialog Box . . . . . . . . . . . . . . . . . . . . . 34-196

Declare Existing Workspace Variables as Tunable Parameters . . 34-196
Declare New Tunable Parameters . . . . . . . . . . . . . . . . . . . . . . . . 34-196
Set Tunable Parameter Code Generation Options . . . . . . . . . . . . 34-197
Programmatically Declare Workspace Variables as Tunable Parameters

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-197

Share Data Between Code Generated from Simulink, Stateflow, and
MATLAB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34-199

Air-Fuel Ratio Control System with Fixed-Point Data . . . . . . . . . 34-201

Data Definition and Declaration Management in
Embedded Coder

35
Control Placement of Global Data Definitions and Declarations in

Generated Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35-2
Organize Data to Support Component-Based, Team-Oriented Model

Development . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35-5
Specify Default Placement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35-7
Override Default Placement for Individual Data Items . . . . . . . . . . . 35-8
Prevent Name Clashes by Configuring Data Item as static . . . . . . . 35-8
Code Generation Impact of Storage Location for Parameter Objects

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35-8
Specify Default #include Syntax for Data Header Files . . . . . . . . . . 35-8

Establish Data Ownership in a Model Hierarchy . . . . . . . . . . . . . . 35-10

xli



Data Types in Embedded Coder
36

Control Data Type Names in Generated Code . . . . . . . . . . . . . . . . . . 36-2
Control Names of Primitive Data Types . . . . . . . . . . . . . . . . . . . . . . 36-2
Control Names of Structure Types . . . . . . . . . . . . . . . . . . . . . . . . . 36-9
Generate Code That Reuses Data Types From External Code . . . . . 36-9
Create Data Type Alias in the Generated Code . . . . . . . . . . . . . . . . 36-9
Create a Named Fixed-Point Data Type in the Generated Code . . . 36-14
Rename Data Type Object . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-17
Display Signal Data Types on Block Diagram . . . . . . . . . . . . . . . . 36-17
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-17

Control File Placement of Custom Data Types . . . . . . . . . . . . . . . . 36-19
Data Scope and Header File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-19
Macro Guards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-20

Replace and Rename Data Types to Conform to Coding Standards
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-22

Inspect External C Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-22
Explore Example Model and Default Generated Code . . . . . . . . . . 36-22
Reuse External Data Type Definitions . . . . . . . . . . . . . . . . . . . . . . 36-23
Create Meaningful Data Type Aliases for Individual Data Items . . 36-24
Create Single Point of Definition for Primitive Types . . . . . . . . . . . 36-25
Permanently Store Data Type Objects . . . . . . . . . . . . . . . . . . . . . . 36-26
Create and Maintain Objects Corresponding to Multiple C typedef

Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-26

Exchange Structured and Enumerated Data Between Generated and
External Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-27

Inspect External Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-27
Create Simulink Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-28
Configure Generated Code to Write Output Data to Existing Structure

Variable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-29
Configure Generated Code to Define Parameter Data . . . . . . . . . . 36-31
Generate, Compile, and Inspect Code . . . . . . . . . . . . . . . . . . . . . . 36-32
Replace Data Type Names Throughout Model . . . . . . . . . . . . . . . . 36-32

Specify Boolean and Data Type Limit Identifiers . . . . . . . . . . . . . . 36-34
Data Type Limit Identifiers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-34
Boolean Identifiers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36-34
Boolean and Data Type Limit Identifier Header Files . . . . . . . . . . 36-35

Module Packaging Tool (MPT) Data Objects in Embedded
Coder

37
MPT Data Object Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37-2

Specify Persistence Level for Signals and Parameters . . . . . . . . . . 37-10

xlii Contents



Storage Classes in Embedded Coder
38

Reuse Parameter Data from External Code in the Generated Code
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-2

Import Parameter Data with Conditionally Compiled Dimension
Length . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-6

Access Structured Data Through a Pointer That External Code
Defines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-10

Create Storage Classes by Using the Custom Storage Class Designer
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-15

Create and Apply a Storage Class . . . . . . . . . . . . . . . . . . . . . . . . . 38-15
Modify a Built-In Storage Class . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-18
Control Data Representation by Configuring Storage Class Properties

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-18
Avoid Errors During Code Generation by Validating Storage Class
Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-21

Make Storage Classes Available Outside the Current Folder . . . . . 38-21
Make Storage Classes Available in the Code Mappings Editor . . . . 38-22
Share Storage Class Between Packages . . . . . . . . . . . . . . . . . . . . 38-22
Control Appearance of Storage Class Drop-Down List . . . . . . . . . . 38-22
Protect Custom Storage Class Definitions . . . . . . . . . . . . . . . . . . . 38-23
Further Customize Generated Code by Writing TLC Code . . . . . . . 38-23

Finely Control Data Representation by Writing TLC Code for a
Storage Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-24

Create Custom Attributes Class for Storage Class . . . . . . . . . . . . . 38-24
Write TLC Code for Storage Class . . . . . . . . . . . . . . . . . . . . . . . . . 38-24
Create Storage Class by Using Custom Storage Class Designer . . 38-24

Access Data Through Functions with Storage Class GetSet . . . . . 38-26
Access Legacy Data Using Get and Set Functions . . . . . . . . . . . . . 38-26
Use GetSet with Vector Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-29
Use GetSet with Structured Data . . . . . . . . . . . . . . . . . . . . . . . . . 38-32
Use GetSet with Matrix Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-36
Specify Header File or Function Naming Scheme for Data Items . 38-40
Access Scalar and Array Data Through Macro Instead of Function Call

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-41
GetSet Storage Class Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . 38-41

Access Data Through Functions by Using Storage Classes in
Embedded Coder Dictionary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-42

Access Legacy Data by Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-42
Access Legacy Data by Pointer . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-44

Integrate External Application Code with Code Generated from PID
Controller . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-46

Configure Generated Code According to Interface Control Document
Specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-55

xliii



Generate Local Variables with Localizable Storage Class . . . . . . . 38-63
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-63
Generate Code with Localizable Storage Class . . . . . . . . . . . . . . . 38-63
Generate Code Without Localizable Storage Class . . . . . . . . . . . . 38-64
Additional Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38-65

Data Object Wizard in Embedded Coder
39

Create Data Objects for Code Generation with Data Object Wizard
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39-2

Entry-Point Functions and Scheduling in Simulink Coder
40

Configure Entry-Point Function Interfaces for Simulink Function and
Function Caller Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-2
Configure Generated C Function Interface for Global Simulink

Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-2
Configure Generated C Function Interface for Exported Scoped

Simulink Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-4
Configure Generated C++ Function Interface for Exported Scoped

Simulink Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-6
Simulink Function Code Interface Limitations . . . . . . . . . . . . . . . . . 40-7

Generate C++ Class Interface to Model or Subsystem Code . . . . . . 40-9
Generate C++ Class Interface to Model Code . . . . . . . . . . . . . . . . . 40-9
Generate C++ Class Interface to Nonvirtual Subsystem Code . . . 40-10
C++ Class Interface Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . 40-10

Execution of Code Generated from a Model . . . . . . . . . . . . . . . . . . 40-12
Program Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-12
Program Timing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-13
External Mode Communication . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-13
Data Logging in Single-Tasking and Multitasking Model Execution

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40-14
Non-Real-Time Single-Tasking Systems . . . . . . . . . . . . . . . . . . . . . 40-14
Non-Real-Time Multitasking Systems . . . . . . . . . . . . . . . . . . . . . . 40-15
Real-Time Single-Tasking Systems . . . . . . . . . . . . . . . . . . . . . . . . 40-16
Real-Time Multitasking Systems . . . . . . . . . . . . . . . . . . . . . . . . . . 40-17
Multitasking Systems Using Real-Time Tasking Primitives . . . . . . 40-18
Rapid Prototyping and Embedded Model Execution Differences . . 40-19

Rapid Prototyping Model Functions . . . . . . . . . . . . . . . . . . . . . . . . 40-21

xliv Contents



Function and Class Interfaces in Embedded Coder
41

Generate Modular Function Code for Nonvirtual Subsystems . . . . 41-2
About Nonvirtual Subsystem Code Generation . . . . . . . . . . . . . . . . 41-2
Configure Subsystem for Generating Modular Function Code . . . . . 41-2
Modular Function Code for Nonvirtual Subsystems . . . . . . . . . . . . . 41-5
Partition Functions in Generated Code . . . . . . . . . . . . . . . . . . . . . . 41-8
Nonvirtual Subsystem Modular Function Code Limitations . . . . . . 41-17

Generate Reentrant, Multi-Instance Code . . . . . . . . . . . . . . . . . . . 41-19

Generate Code for String Blocks by using the Standard C++ String
Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41-23

Configure C++ Class Interface
42

Interactively Configure C++ Interface . . . . . . . . . . . . . . . . . . . . . . . 42-2
Interactive Workflow Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-2
Open Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-2
Configure Model as Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-4
Configure Model Data Elements as Class Members . . . . . . . . . . . . . 42-5
Configure Model Functions as Class Methods . . . . . . . . . . . . . . . . 42-14
Generate C++ Class Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-22
Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-23

Programmatically Configure C++ Interface . . . . . . . . . . . . . . . . . . 42-25
Programmatic Workflow Overview . . . . . . . . . . . . . . . . . . . . . . . . 42-25
Open Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-25
Configure Model as Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-27
Configure Model Data Elements as Class Members . . . . . . . . . . . . 42-28
Configure Model Functions as Class Methods . . . . . . . . . . . . . . . . 42-36
Generate C++ Class Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-41
Considerations and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . 42-42

Configure C++ Class Interface for Rate-Based Models . . . . . . . . . 42-44

Configure C++ Class Interface for Export-Function Models . . . . . 42-48

Memory Sections in Embedded Coder
43

Control Data and Function Placement in Memory by Inserting
Pragmas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-2

Insert Pragmas by Using Memory Sections . . . . . . . . . . . . . . . . . . . 43-2
Configure Pragma to Surround Groups of Definitions . . . . . . . . . . . 43-6

xlv



Override Default Memory Placement for Individual Data Elements
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-6

Choose Where to Create and Store Memory Section Definition . . . . 43-7
Share Memory Section Definition Between Models . . . . . . . . . . . . . 43-7
Override Default Memory Placement for Subsystem Functions and

Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-7
Share Memory Section Between Packages (Package Memory Sections

Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-9
Control Appearance of Memory Section Drop-Down List (Package

Memory Sections Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-10
Protect Definitions of Package Memory Sections (Package Memory

Sections Only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-10
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-10
Insert Pragmas for Functions and Data in Generated Code . . . . . . 43-11

Protect Global Data with const and volatile Type Qualifiers . . . . . 43-13
Maintain const Correctness for Arguments of Entry-Point Functions

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-13
Incorrect Results or Undefined Behavior When Passing Volatile Data to

a Generated Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43-13

Array Layout
44

Column-Major Layout to Row-Major Layout Conversion of Models
with Lookup Table Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44-2

Interpolation Algorithm for Row-Major Array Layout . . . . . . . . . . . 44-9

Interpolation with Subtable Selection Algorithm for Row-Major Array
Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44-15

Direct Lookup Table Algorithm for Row-Major Array Layout . . . . 44-21

Generate Row-Major Code for S-Functions . . . . . . . . . . . . . . . . . . . 44-28

Row-Major Algorithms for Row-Major Array Layout . . . . . . . . . . . 44-31

Generate Row-Major Code for Model That Contains a MATLAB
Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44-34

Row-Major Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44-34
Mixed-Majority Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . 44-35

Preserve Dimensions
45

Preserve Dimensions of Multidimensional Arrays in Generated Code
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45-2
Configure Default Model Data Elements to Preserve Dimensions . . 45-2

xlvi Contents



Configure Individual Model Data Elements to Preserve Dimensions
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45-3

Storage Classes Supported to Preserve Dimensions . . . . . . . . . . . . 45-5
Preserve Dimensions for New Storage Classes . . . . . . . . . . . . . . . . 45-5
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45-5

Preserve Dimensions of Bus Elements in Generated Code . . . . . . . 45-7

Code Generation

Configuration for Simulink Coder
46

Code Generation Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-2
Open the Model Configuration for Code Generation . . . . . . . . . . . . 46-2
Configuration Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-2

Configure Code Generation Parameters for Model Programmatically
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-4

Modify Parameters to Support Execution efficiency . . . . . . . . . . . . 46-4

Configure Model from Command Line . . . . . . . . . . . . . . . . . . . . . . . . 46-6

Use Configuration Reference to Select Code Generation Target . . 46-11

Check Model and Configuration for Code Generation . . . . . . . . . . 46-16
Check Mode for Code Efficiency with Model Advisor . . . . . . . . . . . 46-16
Check Model During Code Generation with Code Generation Advisor

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-16

Application Objectives Using Code Generation Advisor . . . . . . . . . 46-18
High-Level Code Generation Objectives . . . . . . . . . . . . . . . . . . . . 46-18
Configure Model for Code Generation Objectives Using Code

Generation Advisor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-19
Configure Model for Code Generation Objectives by Using
Configuration Parameters Dialog Box . . . . . . . . . . . . . . . . . . . . 46-19

Simulink Coder Model Advisor Checks for Standards and Code
Efficiency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-21

Configure Code Comments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-22

Include MATLAB Code as Comments in Generated Code . . . . . . . 46-23
Include MATLAB Code as Comments in the Generated Code . . . . . 46-23
Location of Comments in Generated Code . . . . . . . . . . . . . . . . . . 46-23
Include MATLAB User Comments in Generated Code . . . . . . . . . . 46-25
Limitations of MATLAB Source Code as Comments . . . . . . . . . . . . 46-26

Construction of Generated Identifiers . . . . . . . . . . . . . . . . . . . . . . . 46-27

xlvii



Identifier Name Collisions and Mangling . . . . . . . . . . . . . . . . . . . . 46-28
Identifier Name Collisions with Referenced Models . . . . . . . . . . . 46-28

Specify Identifier Length to Avoid Naming Collisions . . . . . . . . . . 46-29

Specify Reserved Names for Generated Identifiers . . . . . . . . . . . . 46-30

Reserved Keywords . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-31
C Reserved Keywords . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-31
C++ Reserved Keywords . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-31
Reserved Keywords for Code Generation . . . . . . . . . . . . . . . . . . . 46-32
Code Generation Code Replacement Library Keywords . . . . . . . . . 46-32

Configure Model for Debugging . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46-34

Configuration in Embedded Coder
47

Configure Model for Code Generation Objectives by Using Code
Generation Advisor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47-2

High-Level Code Generation Objectives . . . . . . . . . . . . . . . . . . . . . 47-2
Specify Objectives in Referenced Models . . . . . . . . . . . . . . . . . . . . 47-3
Configure Model Using Code Generation Advisor . . . . . . . . . . . . . . 47-3
Configure Model for Code Generation Objectives by Using
Configuration Parameters Dialog Box . . . . . . . . . . . . . . . . . . . . . 47-5

Configure Code Generation Objectives Programmatically . . . . . . . . 47-7

Check Model and Configuration for Code Generation . . . . . . . . . . . 47-8
Check Model During Code Generation . . . . . . . . . . . . . . . . . . . . . . 47-8

Embedded Coder Model Advisor Checks for Standards, Guidelines,
and Code Efficiency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47-10

Create Custom Code Generation Objectives . . . . . . . . . . . . . . . . . . 47-13
Specify Parameters in Custom Objectives . . . . . . . . . . . . . . . . . . . 47-13
Specify Checks in Custom Objectives . . . . . . . . . . . . . . . . . . . . . . 47-13
Determine Checks and Parameters in Existing Objectives . . . . . . . 47-14
Steps to Create Custom Objectives . . . . . . . . . . . . . . . . . . . . . . . . 47-15

Configuration Variations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47-17

Configure and Optimize Model with Configuration Wizard Blocks
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47-18
Configuration Wizard Block Library . . . . . . . . . . . . . . . . . . . . . . . 47-18
Add a Configuration Wizard Block . . . . . . . . . . . . . . . . . . . . . . . . 47-19
Use Configuration Wizard Blocks to Configure Your Model . . . . . . 47-20
Create a Custom Configuration Wizard Block . . . . . . . . . . . . . . . . 47-20

Aircraft Position Radar Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47-25

xlviii Contents



System Target File Configuration
48

Configure a System Target File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48-2
Select a Solver That Supports Code Generation . . . . . . . . . . . . . . . 48-2
Select a System Target File from STF Browser . . . . . . . . . . . . . . . . 48-2
Select a System Target File Programmatically . . . . . . . . . . . . . . . . 48-3
Develop Custom System Target Files . . . . . . . . . . . . . . . . . . . . . . . 48-4

Configure STF-Related Code Generation Parameters . . . . . . . . . . . . 48-5
Specify Generated Code Interfaces . . . . . . . . . . . . . . . . . . . . . . . . . 48-5
Configure Numeric Data Support . . . . . . . . . . . . . . . . . . . . . . . . . . 48-8
Configure Time Value Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48-8
Configure Noninlined S-Function Support . . . . . . . . . . . . . . . . . . . . 48-9
Configure Model Function Generation and Argument Passing . . . . . 48-9
Configure Code Reuse Support . . . . . . . . . . . . . . . . . . . . . . . . . . . 48-10

Configure a Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . 48-12

Configure Standard Math Library for Target System . . . . . . . . . . . 48-13

Compare System Target File Support Across Products . . . . . . . . . 48-16
Compare Product System Target Files . . . . . . . . . . . . . . . . . . . . . 48-17
Compare Code Styles and STF Support . . . . . . . . . . . . . . . . . . . . 48-19
Compare Generated Code Features by Product . . . . . . . . . . . . . . . 48-20
Compare Generated Code Features by STF . . . . . . . . . . . . . . . . . . 48-22

Internationalization Support in Embedded Coder
49

Internationalization and Code Generation . . . . . . . . . . . . . . . . . . . . 49-2
Locale Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49-2
Prepare to Generate Code for Mixed Languages and Locales . . . . . 49-2
Character Set Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49-2
XML Escape Sequence Replacements . . . . . . . . . . . . . . . . . . . . . . . 49-3
CGT Files and XML Escape Sequence Replacements . . . . . . . . . . . . 49-3
Generate and Review Code with Mixed Languages and Mixed Locales

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49-3

Source Code Generation in Simulink Coder
50

Configure Model, Generate Code, and Simulate . . . . . . . . . . . . . . . . 50-2
About This Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-2
Functional Design of the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-2
View the Top Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-2
View the Subsystems . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-3
Simulation Test Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-4

xlix



Run Simulation Tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-8
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-9
Learn More . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-10

Configure Model and Generate Code . . . . . . . . . . . . . . . . . . . . . . . . 50-11
About This Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-11
Configure the Model for Code Generation . . . . . . . . . . . . . . . . . . . 50-11
Save Your Model Configuration as a MATLAB Function . . . . . . . . . 50-12
Check Model Conditions and Configuration Settings . . . . . . . . . . . 50-13
Generate Code for the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-13
Review the Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-13
Generate an Executable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-14
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-14

Configure Data Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-16
About This Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-16
Declare Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-16
Use Data Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-17
Add New Data Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-19
Enable Data Objects for Generated Code . . . . . . . . . . . . . . . . . . . 50-19
Effects of Simulation on Data Typing . . . . . . . . . . . . . . . . . . . . . . 50-20
Manage Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-21
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-22

Call External C Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-23
About This Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-23
Include External C Functions in a Model . . . . . . . . . . . . . . . . . . . . 50-23
Create a Block That Calls a C Function . . . . . . . . . . . . . . . . . . . . . 50-23
Validate External Code in the Simulink Environment . . . . . . . . . . 50-25
Validate C Code as Part of a Model . . . . . . . . . . . . . . . . . . . . . . . . 50-26
Call a C Function from Generated Code . . . . . . . . . . . . . . . . . . . . 50-27
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-27

Reload Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-29

Manage Build Process Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-30
File Generation Control Parameters . . . . . . . . . . . . . . . . . . . . . . . 50-30
Build Process Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-31

Manage Build Process Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-34
model.bat . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-38
model.h . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-38
rtwtypes.h . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-39

Manage Build Process File Dependencies . . . . . . . . . . . . . . . . . . . . 50-41
System Header Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-42
Code Generator Header Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-44

Add Build Process Dependencies . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-50
File Dependency Information for the Build Process . . . . . . . . . . . . 50-50
Folder Dependency Information for the Build Process . . . . . . . . . . 50-52

Build Process Support for Folder Names with Spaces or Special
Characters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-55

Folder Names with Spaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-55

l Contents



Folder Names with Special Characters . . . . . . . . . . . . . . . . . . . . . 50-57
Troubleshooting Errors When Folder Names Have Spaces . . . . . . 50-57

Code Generation of Matrices and Arrays . . . . . . . . . . . . . . . . . . . . . 50-60
Array Storage in Computer Memory . . . . . . . . . . . . . . . . . . . . . . . 50-60
Code Generator Matrix Parameters . . . . . . . . . . . . . . . . . . . . . . . 50-62
Internal Data Storage for Complex Number Arrays . . . . . . . . . . . . 50-64
Unsupported Blocks for Row-Major Code Generation . . . . . . . . . . 50-64
Limitations for Row-Major Code Generation . . . . . . . . . . . . . . . . . 50-65

Cross-Release Shared Utility Code Reuse . . . . . . . . . . . . . . . . . . . . 50-66
Workflow to Reuse Shared Utility Code . . . . . . . . . . . . . . . . . . . . . 50-66
Required Editing for Shared Utility Code Reuse . . . . . . . . . . . . . . 50-67

Cross-Release Code Integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-68
Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-68
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-70
Simulink.Bus Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-71
Root-Level I/O Through Global Variables in Generated Code . . . . . 50-72
Communicate Between Current and Previous Release Components

Through Global Data Stores . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-74
Parameter Tuning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-75
Use Multiple Instances of Code Generated from Reusable Referenced

Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-76
Compare Simulation Behavior of Model Component in Current Release

and Generated Code from Previous Release . . . . . . . . . . . . . . . 50-77
Import AUTOSAR Code from Previous Releases . . . . . . . . . . . . . . 50-78

Integration of Code from Multiple Folders . . . . . . . . . . . . . . . . . . . 50-79

Integrate Generated Code by Using Cross-Release Workflow . . . . 50-82

Use Protected Models from Previous Releases to Perform SIL Testing
and Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-90

Compile Code in Another Development Environment . . . . . . . . . . 50-96

Generate Code and Simulate Models in a Project . . . . . . . . . . . . . 50-99

Generate Code and Simulate Models Programmatically with Project
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50-102

Source Code Generation in Embedded Coder
51

Generate Code Using Embedded Coder® . . . . . . . . . . . . . . . . . . . . . 51-2

Generate Code by Using the Quick Start Tool . . . . . . . . . . . . . . . . . . 51-9
Quick Start Model Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-9
Configuration Parameter Changes for Models That Have a
Configuration Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-10

Next Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-11

li



Manage File Packaging of Generated Code Modules . . . . . . . . . . . 51-12
Generated Code Modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-12
User-Written Code Modules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-14
Customize Generated Code Modules . . . . . . . . . . . . . . . . . . . . . . . 51-14

Tutorial for Generating C Code from a Control Algorithm for an
Embedded System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-17

Third-Party Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-17

Prepare a Control Algorithm Model for C Code Generation . . . . . 51-18

Configure Data Interface in the Generated Code . . . . . . . . . . . . . . 51-29

Partition Functions in Generated Code . . . . . . . . . . . . . . . . . . . . . . 51-38

Call External C Code from Model and Generated Code . . . . . . . . . 51-47

Build Integrated Code Outside the Simulink Environment . . . . . . 51-52

Test Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51-57

Evaluate Performance of the Generated Code . . . . . . . . . . . . . . . . 51-63

Install and Use Cygwin and Eclipse . . . . . . . . . . . . . . . . . . . . . . . . . 51-67

Report Generation in Embedded Coder
52

Reports for Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-2
HTML Code Generation Report Location . . . . . . . . . . . . . . . . . . . . 52-2
HTML Code Generation Report for Referenced Models . . . . . . . . . . 52-2
HTML Code Generation Report Extensions . . . . . . . . . . . . . . . . . . . 52-3

Generate a Code Generation Report . . . . . . . . . . . . . . . . . . . . . . . . . 52-5

Generate Code Generation Report After Build Process . . . . . . . . . . 52-6

Open Code Generation Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-7
Limitation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-7

Generate Code Generation Report Programmatically . . . . . . . . . . . 52-8

Package and Share the Code Generation Report . . . . . . . . . . . . . . . 52-9
Package the Code Generation Report . . . . . . . . . . . . . . . . . . . . . . . 52-9
View the Code Generation Report . . . . . . . . . . . . . . . . . . . . . . . . . . 52-9

Web View of Model in Code Generation Report . . . . . . . . . . . . . . . 52-10
About Model Web View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-10
Generate HTML Code Generation Report with Model Web View . . 52-10
Model Web View Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-12

lii Contents



Analyze the Generated Code Interface . . . . . . . . . . . . . . . . . . . . . . 52-13
Code Interface Report Overview . . . . . . . . . . . . . . . . . . . . . . . . . . 52-13
Generating a Code Interface Report . . . . . . . . . . . . . . . . . . . . . . . 52-13
Navigating Code Interface Report Subsections . . . . . . . . . . . . . . . 52-16
Interpreting the Entry-Point Functions Subsection . . . . . . . . . . . . 52-16
Interpreting the Inports and Outports Subsections . . . . . . . . . . . . 52-19
Interpreting the Interface Parameters Subsection . . . . . . . . . . . . . 52-20
Interpreting the Data Stores Subsection . . . . . . . . . . . . . . . . . . . . 52-21
Code Interface Report Limitations . . . . . . . . . . . . . . . . . . . . . . . . 52-21

Static Code Metrics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-23
Static Code Metrics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-23
Static Code Metrics Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-23
View Static Code Metrics and Definitions Within the Generated Code

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-25
Static Code Metrics Report Limitations . . . . . . . . . . . . . . . . . . . . 52-26

Generate Static Code Metrics Report for Simulink Model . . . . . . 52-27

Generating a Static Code Metrics Report for Code Generated from
MATLAB Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-31

Example Static Code Metrics Report . . . . . . . . . . . . . . . . . . . . . . 52-31
Requirements for Running Static Code Metrics Analysis After Code

Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-33
Running Static Code Metrics at Code Generation Time . . . . . . . . . 52-33

Analyze Code Replacements in Generated Code . . . . . . . . . . . . . . . 52-34

Document Generated Code with Simulink Report Generator . . . . 52-36
Generate Code for the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-36
Open the Report Generator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-37
Set Report Name, Location, and Format . . . . . . . . . . . . . . . . . . . . 52-39
Include Models and Subsystems in a Report . . . . . . . . . . . . . . . . . 52-40
Customize the Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-40
Generate the Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52-41

Get Code Description of Generated Code . . . . . . . . . . . . . . . . . . . . 52-42

Code Appearance in Embedded Coder
53

Customize Code Comments to Enhance Readability and Traceability
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-2

Add Custom Comments for Variables in the Generated Code . . . . . 53-3
Embed Handwritten Comments for Signals or Parameters . . . . . . . 53-3
Generate Dynamic Comments Based on Data Properties . . . . . . . . . 53-3

Add Global Comments in the Generated Code . . . . . . . . . . . . . . . . . 53-5
Use a Simulink DocBlock to Add a Comment . . . . . . . . . . . . . . . . . . 53-5
Use a Simulink Annotation to Add a Comment . . . . . . . . . . . . . . . . 53-7
Use Sorted Notes to Add Comments . . . . . . . . . . . . . . . . . . . . . . . . 53-8

liii



Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-9

Customize Generated Identifier Naming Rules . . . . . . . . . . . . . . . 53-10
Apply Naming Rules to Identifiers Globally . . . . . . . . . . . . . . . . . . 53-10
Apply Naming Rules to Simulink Data Objects . . . . . . . . . . . . . . . 53-11

Identifier Format Control . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-15
Control Case with Token Decorators . . . . . . . . . . . . . . . . . . . . . . . 53-18
Control Formatting of Identifiers . . . . . . . . . . . . . . . . . . . . . . . . . 53-19

Control Name Mangling in Generated Identifiers . . . . . . . . . . . . . 53-21
Minimize Name Mangling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-21

Avoid Identifier Name Collisions with Referenced Models . . . . . . 53-22
Use Model Advisor to Detect Identifier Names Changed During Code

Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-22

Maintain Traceability for Generated Identifiers . . . . . . . . . . . . . . . 53-23

Exceptions to Identifier Formatting Conventions . . . . . . . . . . . . . . 53-24

Identifier Format Control Parameters Limitations . . . . . . . . . . . . . 53-25

Control Parentheses in Generated Code . . . . . . . . . . . . . . . . . . . . . 53-27
Control Use of Parentheses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-27

Optimize Code by Reordering Commutable Operands . . . . . . . . . . 53-29
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-29
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-29
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 53-29

Suppress Generation of Default Cases for Unreachable Stateflow
Switch Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-31

Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-31
Generate Code with Default Cases for Unreachable Stateflow Switch

Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-33
Suppress Default Cases for Unreachable Stateflow Switch Statements

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-33

Replace Multiplication by Powers of Two with Signed Bitwise Shifts
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-34

Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-34
Generate Code with Signed Bitwise Shifts . . . . . . . . . . . . . . . . . . 53-34
Generate Code with Multiplication by Powers of Two . . . . . . . . . . 53-34

Generate Code Containing Right Shifts on Signed Integers . . . . . 53-36
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-36
Generate Code Containing Right Shifts on Signed Integers . . . . . . 53-36
Generate Code That Does Not Allow Right Shifts on Signed Integers

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-36

Control Cast Expressions in Generated Code . . . . . . . . . . . . . . . . . 53-38
Enable Nominal Casting Mode and Generate Code . . . . . . . . . . . . 53-38
Enable Standards Compliant Casting Mode and Generate Code . . 53-39
Enable Explicit Casting Mode and Generate Code . . . . . . . . . . . . . 53-40

liv Contents



Customize Code Organization and Format . . . . . . . . . . . . . . . . . . . 53-42
Custom File Processing Components . . . . . . . . . . . . . . . . . . . . . . 53-42
Custom File Processing Configuration . . . . . . . . . . . . . . . . . . . . . 53-43

Specify Templates For Code Generation . . . . . . . . . . . . . . . . . . . . . 53-44

Code Generation Template (CGT) Files . . . . . . . . . . . . . . . . . . . . . . 53-45
Default CGT file . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-45
CGT File Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-45
Built-In Tokens and Sections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-46
Subsections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-47

Format Generated Code Files by Using Templates . . . . . . . . . . . . . 53-49

Custom File Processing (CFP) Templates . . . . . . . . . . . . . . . . . . . . 53-51
Custom File Processing (CFP) Template Structure . . . . . . . . . . . . 53-51
Generate Additional Files Required to Interface with an Application

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-52

Change the Organization of a Generated File . . . . . . . . . . . . . . . . . 53-54

Customize Generated File Names . . . . . . . . . . . . . . . . . . . . . . . . . . 53-56

Generate Source and Header Files with a Custom File Processing
(CFP) Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-58

Generate Code with a CFP Template . . . . . . . . . . . . . . . . . . . . . . . 53-58
Analysis of the Example CFP Template and Generated Code . . . . . 53-59
Generate a Custom Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-62
Custom Tokens . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-63

Comparison of a Template and Its Generated File . . . . . . . . . . . . . 53-64
Template and Generated File . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-64

Code Template API Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-67

Generate Custom File and Function Banners . . . . . . . . . . . . . . . . . 53-70
Create a Custom File and Function Banner Template . . . . . . . . . . 53-70
Customize a Code Generation Template (CGT) File for File and

Function Banner Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-71

Template Symbols and Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-77
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-77
Template Symbol Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-77
Template Symbols . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-79
Rules for Modifying or Creating a Template . . . . . . . . . . . . . . . . . 53-81

Annotate Code for Justifying Polyspace Checks . . . . . . . . . . . . . . . 53-82

Enhance Readability of Code for Flow Charts . . . . . . . . . . . . . . . . . 53-91
Appearance of Generated Code for Flow Charts . . . . . . . . . . . . . . 53-91
Convert If-Elseif-Else Code to Switch-Case Statements . . . . . . . . . 53-93
Example of Converting Code to Switch-Case Statements . . . . . . . . 53-95

Enhance Code Readability for MATLAB Function Blocks . . . . . . 53-101
Requirements for Using Readability Optimizations . . . . . . . . . . . 53-101

lv



Converting If-Elseif-Else Code to Switch-Case Statements . . . . . 53-101
Example of Converting Code for If-Elseif-Else Decision Logic to Switch-

Case Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-103

Improve Data Coherency in Generated Code . . . . . . . . . . . . . . . . 53-107
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53-107
Generate Code Without Parameter Enabled . . . . . . . . . . . . . . . . 53-107
Generate Code With Parameter Enabled . . . . . . . . . . . . . . . . . . . 53-108

Code Replacement in Simulink Coder
54

What Is Code Replacement? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54-2
Code Replacement Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54-2
Code Replacement Terminology . . . . . . . . . . . . . . . . . . . . . . . . . . . 54-4
Code Replacement Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54-5

Choose a Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . . 54-6
About Choosing a Code Replacement Library . . . . . . . . . . . . . . . . . 54-6
Explore Available Code Replacement Libraries . . . . . . . . . . . . . . . . 54-6
Explore Code Replacement Library Contents . . . . . . . . . . . . . . . . . 54-6

Replace Code Generated from Simulink Models . . . . . . . . . . . . . . . 54-8

Code Replacement for Simulink Models in Embedded
Coder

55
What Is Code Replacement? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55-2

Code Replacement Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55-2
Code Replacement Terminology . . . . . . . . . . . . . . . . . . . . . . . . . . . 55-4
Code Replacement Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55-5

Choose a Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . . 55-6
About Choosing a Code Replacement Library . . . . . . . . . . . . . . . . . 55-6
Explore Available Code Replacement Libraries . . . . . . . . . . . . . . . . 55-6
Explore Code Replacement Library Contents . . . . . . . . . . . . . . . . . 55-6

Replace Code Generated from Simulink Models . . . . . . . . . . . . . . . 55-8

lvi Contents



Deployment

External Code Integration in Simulink Coder
56

What Is External Code Integration? . . . . . . . . . . . . . . . . . . . . . . . . . . 56-2

Choose an External Code Integration Workflow . . . . . . . . . . . . . . . . 56-3
Choose a Software Execution Framework for Scheduling Code

Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-3
Evaluate Characteristics of External Code . . . . . . . . . . . . . . . . . . . 56-5
Identify Integration Requirements . . . . . . . . . . . . . . . . . . . . . . . . . 56-6
Choose a Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-7

Configure Target Hardware Characteristics . . . . . . . . . . . . . . . . . . . 56-9

Check Code Generation Assumptions . . . . . . . . . . . . . . . . . . . . . . . 56-12
Check Code Generator Assumptions for Development Computer . . 56-12
Coder Assumptions List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-13

Call Reusable External Algorithm Code for Simulation and Code
Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-15
Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-15
Choose an Integration Approach . . . . . . . . . . . . . . . . . . . . . . . . . . 56-16
Insert External Code into Stateflow Charts . . . . . . . . . . . . . . . . . . 56-23

Place External C/C++ Code in Generated Code . . . . . . . . . . . . . . . 56-30
Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-30
Choose an Integration Approach . . . . . . . . . . . . . . . . . . . . . . . . . . 56-31
Integrate External Code by Using Custom Code Blocks . . . . . . . . . 56-32
Integrate External Code by Using Model Configuration Parameters

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-34
Integrate External C Code Into Generated Code By Using Custom

Code Blocks and Model Configuration Parameters . . . . . . . . . . 56-35

Call External Device Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-38

Apply Function and Operator Code Replacements . . . . . . . . . . . . . 56-39

Build Integrated Code Within the Simulink Environment . . . . . . . 56-40
Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-40
Configure Parameters for Integrated Code Build Process . . . . . . . 56-40
Preserve External Code Files in Build Folder . . . . . . . . . . . . . . . . 56-41
Build Support for S-Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-42

Generate Component Source Code for Export to External Code Base
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-47

Modeling Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-47
Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-47
Limitations for Export-Function Subsystems . . . . . . . . . . . . . . . . . 56-49
Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-49
Choose an Integration Approach . . . . . . . . . . . . . . . . . . . . . . . . . . 56-50

lvii



Generate C Function Code for Export-Function Model . . . . . . . . . 56-51
Generate C++ Function and Class Code for Export-Function Model

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-54
Generate Code for Export-Function Subsystems . . . . . . . . . . . . . . 56-59

Generate Shared Library for Export to External Code Base . . . . . 56-62
About Generated Shared Libraries . . . . . . . . . . . . . . . . . . . . . . . . 56-62
Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-62
Generate Shared Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-63
Create Application Code That Uses Generated Shared Libraries . . 56-63
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-66

Interface to a Development Computer Simulator By Using a Shared
Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-67

Exchange Data Between External C/C++ Code and Simulink Model or
Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-69

Import External Code into Model . . . . . . . . . . . . . . . . . . . . . . . . . 56-69
Export Generated Code to External Environment . . . . . . . . . . . . . 56-70
Simulink Representations of C Data Types and Constructs . . . . . . 56-70
Considerations for Other Modeling Goals . . . . . . . . . . . . . . . . . . . 56-75

Exchange Data Between External Calling Code and Generated Code
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56-77

Data Exchange for Reentrant Generated Code . . . . . . . . . . . . . . . 56-77
Data Exchange for Nonreentrant Generated Code . . . . . . . . . . . . 56-77

Generate Code That Matches Appearance of External Code . . . . . 56-80

Program Building, Interaction, and Debugging in
Simulink Coder

57
Select C or C++ Programming Language . . . . . . . . . . . . . . . . . . . . . 57-2

Select and Configure C or C++ Compiler . . . . . . . . . . . . . . . . . . . . . 57-3
Language Standards Compliance . . . . . . . . . . . . . . . . . . . . . . . . . . 57-3
Programming Language Considerations . . . . . . . . . . . . . . . . . . . . . 57-4
C++ Language Support Limitations . . . . . . . . . . . . . . . . . . . . . . . . 57-4
Code Generator Assumes Wrap on Signed Integer Overflows . . . . . 57-5
Choose and Configure Compiler . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-5
Include S-Function Source Code . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-6

Troubleshoot Compiler Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-7
Compiler Version Mismatch Errors . . . . . . . . . . . . . . . . . . . . . . . . . 57-7
Results for Model Simulation and Program Execution Differ . . . . . . 57-7
Generates Expected Code and Produces Unexpected Results . . . . . 57-8
Compile-Time Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-8
LCC Compiler Does Not Support Ampersands in Source Folder Paths

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-9
LCC Compiler Might Not Support Line Lengths of Rapid Accelerator

Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-9

lviii Contents



Choose Build Approach and Configure Build Process . . . . . . . . . . 57-11
Toolchain Approach . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-11
Upgrade Model to Use Toolchain Approach . . . . . . . . . . . . . . . . . . 57-13
Template Makefile Approach . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-15
Specify TLC for Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . 57-18
Use of Checksums in Recompilation of Generated Code . . . . . . . . 57-19

Template Makefiles and Make Options . . . . . . . . . . . . . . . . . . . . . . 57-21
Types of Template Makefiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-21
Specify Template Makefile Options . . . . . . . . . . . . . . . . . . . . . . . . 57-21
Template Makefiles for UNIX Platforms . . . . . . . . . . . . . . . . . . . . 57-22
Template Makefiles for the Microsoft Visual C++ Compiler . . . . . 57-22
Template Makefiles for the LCC Compiler . . . . . . . . . . . . . . . . . . . 57-23

Build Process Workflow for Real-Time Systems . . . . . . . . . . . . . . . 57-25
Working Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-25
Build Folder and Code Generation Folders . . . . . . . . . . . . . . . . . . 57-25
Set Model Parameters for Code Generation . . . . . . . . . . . . . . . . . 57-25
Configure Build Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-26
Set Code Generation Parameters . . . . . . . . . . . . . . . . . . . . . . . . . 57-27
Build and Run a Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-28
Contents of the Build Folder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-29
Customized Makefile Generation . . . . . . . . . . . . . . . . . . . . . . . . . 57-30

Build Models from a Windows Command Prompt Window . . . . . . 57-31

Rebuild a Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-33

Control Regeneration of Top Model Code . . . . . . . . . . . . . . . . . . . . 57-34
Regeneration of Top Model Code . . . . . . . . . . . . . . . . . . . . . . . . . 57-34
Force Regeneration of Top Model Code . . . . . . . . . . . . . . . . . . . . . 57-34

Reduce Build Time for Referenced Models by Using Parallel Builds
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-36

Build Referenced Models in Parallel . . . . . . . . . . . . . . . . . . . . . . . 57-36
Monitor Parallel Building of Referenced Models . . . . . . . . . . . . . . 57-36

Relocate Code to Another Development Environment . . . . . . . . . . 57-41
Code Relocation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-41
Package Code Using the User Interface . . . . . . . . . . . . . . . . . . . . 57-41
Package Code Using the Command-Line Interface . . . . . . . . . . . . 57-42
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-45

Compile and Debug Generated C Code with Microsoft® Visual
Studio® . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-46

Executable Program Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-47

Profile Code Execution Speed . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57-49
Use the Profile Hook Function Interface . . . . . . . . . . . . . . . . . . . . 57-49
Profile Hook Function Interface Limitation . . . . . . . . . . . . . . . . . . 57-50

lix



Host/Target Communication in Simulink Coder
58

External Mode Simulations for Parameter Tuning and Signal
Monitoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-2

Communication Mechanisms for External Mode . . . . . . . . . . . . . . . 58-3
Simulink Feature Support for External Mode . . . . . . . . . . . . . . . . . 58-3
External Mode Simulations by Using the Run on Custom Hardware

App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-4
External Mode Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-5
Security for External Mode Simulations . . . . . . . . . . . . . . . . . . . . . 58-5

External Mode Simulation by Using XCP Communication . . . . . . . . 58-7
Run XCP External Mode Simulation on Development Computer . . . 58-7
Triggered Signal Monitoring for XCP External Mode Simulations

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-12
Run XCP External Mode Simulation From Command Line . . . . . . . 58-15
Target Application Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-16
XCP External Mode Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . 58-17

Graphical Controls for XCP External Mode Simulations . . . . . . . . 58-21
Equivalent Controls on Hardware Tab and External Mode Control

Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-21
XCP External Mode Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . 58-22
XCP External Signal & Triggering Dialog Box . . . . . . . . . . . . . . . . 58-23

Set Up Connectivity Between Simulink and Target Hardware . . . . 58-28
Customise Connectivity for XCP External Mode Simulations . . . . . 58-29
Customize Connectivity for TCP/IP or Serial External Mode

Simulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-33
Execution Tool Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-34

Customize XCP Slave Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-35
External Mode Abstraction Layer . . . . . . . . . . . . . . . . . . . . . . . . . 58-36
XCP Slave Protocol Layer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-38
XCP Slave Transport Layer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-38
XCP Platform Abstraction Layer . . . . . . . . . . . . . . . . . . . . . . . . . . 58-39

External Mode Simulation with TCP/IP or Serial Communication
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-44

Create and Configure Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-44
Build Target Executable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-46
Run Target Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-47
Tune Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-47
Stop Target Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-50
Control Memory Allocation for Communication Buffers in Target . 58-50
TCP/IP or Serial External Mode Control Panel . . . . . . . . . . . . . . . 58-50
Configure Host Monitoring of Target Application Signal Data . . . . 58-53
Configure Host Archiving of Target Application Signal Data . . . . . 58-59
Summary of Graphical Controls for TCP/IP or Serial External Mode

Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-61
Blocks and Subsystems Compatible with External Mode . . . . . . . . 58-62
External Mode Mechanism for Downloading Tunable Parameters

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-64
Choose Communication Protocol for Client and Server . . . . . . . . . 58-67

lx Contents



Use External Mode Programmatically . . . . . . . . . . . . . . . . . . . . . . 58-73
Animate Stateflow Charts in External Mode . . . . . . . . . . . . . . . . . 58-77
TCP/IP and Serial External Mode Limitations . . . . . . . . . . . . . . . . 58-79

Create a Transport Layer for TCP/IP or Serial External Mode
Communication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-82

Design of External Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-82
External Mode Communications Overview . . . . . . . . . . . . . . . . . . 58-84
External Mode Source Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58-85
Implement a Custom Transport Layer . . . . . . . . . . . . . . . . . . . . . . 58-88

Logging in Simulink Coder
59

Log Program Execution Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59-2
Log Data for Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59-2
Configure State, Time, and Output Logging . . . . . . . . . . . . . . . . . . 59-7
Log Data with Scope and To Workspace Blocks . . . . . . . . . . . . . . . . 59-9
Log Data with To File Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59-9
Data Logging Differences Between Single- and Multitasking . . . . . . 59-9

Data Interchange Using the C API in Simulink Coder
60

Exchange Data Between Generated and External Code Using C API
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-2

Generated C API Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-2
Generate C API Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-3
Description of C API Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-4
Generate C API Data Definition File for Exchanging Data with a Target

System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-15
C API Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-16

Use C API to Access Model Signals and States . . . . . . . . . . . . . . . . 60-18

Use C API to Access Model Parameters . . . . . . . . . . . . . . . . . . . . . . 60-23

ASAP2 Data Measurement and Calibration in Simulink
Coder

61
Export ASAP2 File for Data Measurement and Calibration . . . . . . . 61-2

What You Should Know . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61-2
System Target Files Supporting ASAP2 . . . . . . . . . . . . . . . . . . . . . . 61-2
Define ASAP2 Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61-3
Generate an ASAP2 File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61-6

lxi



Structure of ASAP2 File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61-8
Create a Host-Based ASAM-ASAP2 Data Definition File for Data

Measurement and Calibration . . . . . . . . . . . . . . . . . . . . . . . . . . . 61-8

Calibrate Generated Code and Monitor Signals . . . . . . . . . . . . . . . 61-10

Direct Memory Access to Generated Code for Simulink
Coder

62
Access Memory in Generated Code Using Global Data Map . . . . . . 62-2

Desktops in Simulink Coder
63

Accelerate, Refine, and Test Hybrid Dynamic System on Host
Computer by Using RSim System Target File . . . . . . . . . . . . . . . . 63-2

About Rapid Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-2
Rapid Simulation Advantage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-2
General Rapid Simulation Workflow . . . . . . . . . . . . . . . . . . . . . . . . 63-2
Identify Rapid Simulation Requirements . . . . . . . . . . . . . . . . . . . . . 63-3
Configure Inports to Provide Simulation Source Data . . . . . . . . . . . 63-4
Configure and Build Model for Rapid Simulation . . . . . . . . . . . . . . . 63-4
Set Up Rapid Simulation Input Data . . . . . . . . . . . . . . . . . . . . . . . . 63-6
Scripts for Batch and Monte Carlo Simulations . . . . . . . . . . . . . . . 63-13
Run Rapid Simulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-13
Tune Parameters Interactively During Rapid Simulation . . . . . . . . 63-21
Rapid Simulation Target Limitations . . . . . . . . . . . . . . . . . . . . . . . 63-22

Run Rapid Simulations Over Range of Parameter Values . . . . . . . 63-24

Run Batch Simulations Without Recompiling Generated Code . . 63-30

Use MAT-Files to Feed Data to Inport Blocks for Rapid Simulations
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-35

Accelerate Simulation, Reuse Code, or Protect Intellectual Property
by Using S-Function Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-40

About the S-Function Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-40
Create S-Function Blocks from a Subsystem . . . . . . . . . . . . . . . . . 63-42
Tunable Parameters in Generated S-Functions . . . . . . . . . . . . . . . 63-45
System Target File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-46
Checksums and the S-Function Target . . . . . . . . . . . . . . . . . . . . . 63-46
Generated S-Function Compatibility . . . . . . . . . . . . . . . . . . . . . . . 63-47
S-Function Target Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63-47

lxii Contents



Desktops in Embedded Coder
64

Package Generated Code as Shared Libraries . . . . . . . . . . . . . . . . . . 64-2
About Generated Shared Libraries . . . . . . . . . . . . . . . . . . . . . . . . . 64-2
Generate Shared Library Version of Model Code . . . . . . . . . . . . . . . 64-2
Create Application Code to Use Shared Library . . . . . . . . . . . . . . . 64-3
Shared Library Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64-6

Real-Time Systems in Simulink Coder
65

Deploy Algorithm Model for Real-Time Rapid Prototyping . . . . . . . 65-2
About Real-Time Rapid Prototyping . . . . . . . . . . . . . . . . . . . . . . . . 65-2
Goals of Real-Time Rapid Prototyping . . . . . . . . . . . . . . . . . . . . . . . 65-2
Refine Code With Real-Time Rapid Prototyping . . . . . . . . . . . . . . . . 65-2

Deploy Environment Model for Real-Time Hardware-In-the-Loop
(HIL) Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65-4

About Hardware-In-the-Loop Simulation . . . . . . . . . . . . . . . . . . . . . 65-4
Set Up and Run HIL Simulations . . . . . . . . . . . . . . . . . . . . . . . . . . 65-4

Untrusted Custom Code, Custom Targets, and Callbacks . . . . . . . . 65-6

Real-Time and Embedded Systems in Embedded Coder
66

Deploy Generated Standalone Executable Programs To Target
Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66-2

Generate a Standalone Program . . . . . . . . . . . . . . . . . . . . . . . . . . . 66-2
Standalone Program Components . . . . . . . . . . . . . . . . . . . . . . . . . . 66-2
Main Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66-3
rt_OneStep and Scheduling Considerations . . . . . . . . . . . . . . . . . . . 66-4
Static Main Program Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66-8
Rate Grouping Compliance and Compatibility Issues . . . . . . . . . . 66-13
Generate Code That Dereferences Data from a Literal Memory

Address . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66-16

Generate Main Program for Deployment to Bare Board Target . . 66-24

Deploy Generated Component Software to Application Target
Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66-26

Interface to an Example Real-Time Multitasking System . . . . . . . . 66-26

lxiii



Code Replacement Customization for Simulink Models in
Embedded Coder

67
What Is Code Replacement Customization? . . . . . . . . . . . . . . . . . . . 67-3

Code Replacement Match and Replacement Process . . . . . . . . . . . . 67-3
Code Replacement Customization Limitations . . . . . . . . . . . . . . . . . 67-3

Code You Can Replace From Simulink Models . . . . . . . . . . . . . . . . . 67-6
Math Functions – Simulink Support . . . . . . . . . . . . . . . . . . . . . . . . 67-6
Math Functions – Stateflow Support . . . . . . . . . . . . . . . . . . . . . . . 67-10
Memory Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-14
Nonfinite Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-15
Mutex and Semaphore Functions . . . . . . . . . . . . . . . . . . . . . . . . . 67-15
Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-16

Develop a Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . 67-20

Quick Start Code Replacement Library Development - Simulink®
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-21

Semaphore and Mutex Function Replacement . . . . . . . . . . . . . . . . 67-30

Identify Code Replacement Library Requirements . . . . . . . . . . . . . 67-35
What Is a Code Replacement Library? . . . . . . . . . . . . . . . . . . . . . 67-35
What Functions Can Be Optimized with a Code Replacement Library?

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-35
How to Develop a Code Replacement Library . . . . . . . . . . . . . . . . 67-35
Identify Basic Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-35

Define Code Replacement Library Optimizations . . . . . . . . . . . . . . 67-36
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 67-36
Programmatically Develop a Code Replacement Library . . . . . . . . 67-39

Register Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . 67-51
Interactively Develop and Load a Registration file . . . . . . . . . . . . 67-51
Programmatically Develop and Load a Registration File . . . . . . . . 67-52

Verify Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-55
Verify Library Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-55
Verify Library Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-55
Verify Library Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-56

Deploy Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . . . 67-57

Troubleshoot Code Replacement Library Registration . . . . . . . . . 67-58

Troubleshoot Code Replacement Misses . . . . . . . . . . . . . . . . . . . . . 67-59
Miss Reason Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-59
Analyze and Correct Code Replacement Misses . . . . . . . . . . . . . . 67-60

Math Function Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . 67-64
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 67-64
Programmatically Develop a Code Replacement Library . . . . . . . . 67-66

lxiv Contents



Generate Code by Using Math Code Replacement Library . . . . . . 67-69

Memory Function Code Replacement . . . . . . . . . . . . . . . . . . . . . . . 67-71
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 67-71
Programmatically Develop a Code Replacement Library . . . . . . . . 67-73

Nonfinite Function Code Replacement . . . . . . . . . . . . . . . . . . . . . . 67-76
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 67-76
Programmatically Develop a Code Replacement Library . . . . . . . . 67-78

Algorithm-Based Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . 67-81
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 67-81
Programmatically Develop a Code Replacement Library . . . . . . . . 67-83

Lookup Table Function Code Replacement . . . . . . . . . . . . . . . . . . . 67-87
Lookup Table Function Signatures . . . . . . . . . . . . . . . . . . . . . . . . 67-87
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 67-90
Programatically develop a code replacement library . . . . . . . . . . . 67-92
Generate Code by Using Lookup Table Code Replacement Library

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-95

Data Alignment for Code Replacement . . . . . . . . . . . . . . . . . . . . . . 67-97
Code Replacement Data Alignment . . . . . . . . . . . . . . . . . . . . . . . . 67-97
Specify Data Alignment Requirements for Function Arguments . . 67-97
Provide Data Alignment Specifications for Compilers . . . . . . . . . . 67-98
Basic Example of Code Replacement Data Alignment . . . . . . . . . 67-101

Replace MATLAB Functions with Custom Code by Using the
coder.replace Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-104

Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-104
Programmatically Develop a Code Replacement Library . . . . . . . 67-106

Replace coder.ceval Calls to External Functions . . . . . . . . . . . . . 67-110
Example Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-110
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-111
Programmatically Develop a Code Replacement Library . . . . . . . 67-113

Reserved Identifiers and Code Replacement . . . . . . . . . . . . . . . . . 67-117

Customize Match and Replacement Process . . . . . . . . . . . . . . . . . 67-118
Customize Code Match and Replacement for Functions . . . . . . . 67-119
Customize Code Match and Replacement for Nonscalar Operations

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-121
Customize Code Match and Replacement for Scalar Operations . 67-124

Scalar Operator Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . 67-129
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-129
Programmatically Develop a Code Replacement Library . . . . . . . 67-131

Addition and Subtraction Operator Code Replacement . . . . . . . . 67-134
Algorithm Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-134
Algorithm Classification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-134
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-135
Programmatically Develop a Code Replacement Library . . . . . . . 67-138
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-140

lxv



Matrix Multiplication Operation to MathWorks BLAS Code
Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-141

Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-141
Programmatically Develop a Code Replacement Library . . . . . . . 67-143
Convert a Matrix Multiplication Operation to MathWorks BLAS

Through Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . 67-148

Matrix Multiplication Operation to ANSI/ISO C BLAS Code
Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-151

Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-151
Programmatically Develop a Code Replacement Library . . . . . . . 67-153

Small Matrix Operation to Processor Code Replacement . . . . . . 67-158
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-158
Programmatically Develop a Code Replacement Library . . . . . . . 67-160
Generate Code to Optimize Performance of a Small Matrix Operation

for Processor-Specific Intrinsic Function . . . . . . . . . . . . . . . . 67-163

Remap Operator Output to Function Input . . . . . . . . . . . . . . . . . . 67-166

Fixed-Point Operator Code Replacement . . . . . . . . . . . . . . . . . . . 67-169
Common Ways to Match Fixed-Point Operator Entries . . . . . . . . 67-169
Fixed-Point Numbers and Arithmetic . . . . . . . . . . . . . . . . . . . . . 67-170
Addition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-171
Subtraction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-171
Multiplication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-172
Division . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-172
Data Type Conversion (Cast) . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-173
Shift . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-173

Binary-Point-Only Scaling Code Replacement . . . . . . . . . . . . . . . 67-175
Programmatically Develop a Code Replacement Library . . . . . . . 67-176

Slope Bias Scaling Code Replacement . . . . . . . . . . . . . . . . . . . . . 67-180
Programmatically Develop a Code Replacement Library . . . . . . . 67-181

Net Slope Scaling Code Replacement . . . . . . . . . . . . . . . . . . . . . . 67-186
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-186
Programmatically Develop a Code Replacement Library . . . . . . . 67-188

Equal Slope and Zero Net Bias Code Replacement . . . . . . . . . . . 67-193
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-193
Programmatically Develop a Code Replacement Library . . . . . . . 67-195

Data Type Conversions (Casts) and Operator Code Replacement
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-199

Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-199
Programmatically Develop a Code Replacement Library . . . . . . . 67-201

Shift Left Operations and Code Replacement . . . . . . . . . . . . . . . . 67-205
Interactively Develop a Code Replacement Library . . . . . . . . . . . 67-205
Programatically Develop a Code Replacement Library . . . . . . . . 67-207

Optimize Generated Code by Using Multiple Code Replacement
Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67-210

lxvi Contents



Code Replacement Customization for MATLAB Code
68

What Is Code Replacement Customization? . . . . . . . . . . . . . . . . . . . 68-3
Code Replacement Match and Replacement Process . . . . . . . . . . . . 68-3
Code Replacement Customization Limitations . . . . . . . . . . . . . . . . . 68-3

Code You Can Replace from MATLAB Code . . . . . . . . . . . . . . . . . . . . 68-5
Math Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-5
Memory Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-8
Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-9

Develop a Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . 68-13

Quick Start Library Development . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-14

Identify Code Replacement Library Requirements . . . . . . . . . . . . . 68-21
What Is a Code Replacement Library? . . . . . . . . . . . . . . . . . . . . . 68-21
What Functions Can Be Optimized with a Code Replacement Library?

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-21
How to Develop a Code Replacement Library . . . . . . . . . . . . . . . . 68-21
Identify Basic Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-21

Define Code Replacement Library Optimizations . . . . . . . . . . . . . . 68-23
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-23
Programmatically Develop a Code Replacement Library . . . . . . . . 68-26

Register Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . 68-38
Interactively Develop and Load a Registration file . . . . . . . . . . . . 68-38
Programmatically Develop and Load a Registration File . . . . . . . . 68-39

Troubleshoot Code Replacement Library Registration . . . . . . . . . 68-42

Verify Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-43
Verify Library Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-43
Verify Library Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-43
Verify Library Performance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-44
Review Code Replacements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-44

Troubleshoot Code Replacement Misses . . . . . . . . . . . . . . . . . . . . . 68-47
Miss Reason Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-47
Analyze and Correct Code Replacement Misses . . . . . . . . . . . . . . 68-48

Deploy Code Replacement Library . . . . . . . . . . . . . . . . . . . . . . . . . . 68-50

Math Function Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . 68-51
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-51
Programmatically Develop a Code Replacement Library . . . . . . . . 68-53

Memory Function Code Replacement . . . . . . . . . . . . . . . . . . . . . . . 68-57
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-57
Programmatically Develop a Code Replacement Library . . . . . . . . 68-59

lxvii



Specify In-Place Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . . 68-62
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-62
Programmatically Develop a Code Replacement Library . . . . . . . . 68-64

Data Alignment for Code Replacement . . . . . . . . . . . . . . . . . . . . . . 68-67
Code Replacement Data Alignment . . . . . . . . . . . . . . . . . . . . . . . . 68-67
Specify Data Alignment Requirements for Function Arguments . . 68-67
Provide Data Alignment Specifications for Compilers . . . . . . . . . . 68-69
Specify Data Alignment in MATLAB Code for Imported Data . . . . . 68-72

Array Layout and Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . 68-73

Allow Shape Agnostic Match . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-75
User Interface Method- Code Replacement Tool . . . . . . . . . . . . . . 68-75
Programmatic Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-76
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-78

Replace MATLAB Functions with Custom Code by Using the
coder.replace Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-79

Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-79
Programmatically Develop a Code Replacement Library . . . . . . . . 68-81

Replace coder.ceval Calls to External Functions . . . . . . . . . . . . . . 68-85
Example Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-85
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-86
Programmatically Develop a Code Replacement Library . . . . . . . . 68-88

Reserved Identifiers and Code Replacement . . . . . . . . . . . . . . . . . . 68-92

Customize Match and Replacement Process . . . . . . . . . . . . . . . . . . 68-93
Customize Match and Replacement Process for Operators . . . . . . 68-94

Scalar Operator Code Replacement . . . . . . . . . . . . . . . . . . . . . . . . . 68-99
Interactively Develop a Code Replacement Library . . . . . . . . . . . . 68-99
Programmatically Develop a Code Replacement Library . . . . . . . 68-101

Addition and Subtraction Operator Code Replacement . . . . . . . . 68-104
Algorithm Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-104
Algorithm Classification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-104
Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-105
Programmatically Develop a Code Replacement Library . . . . . . . 68-108
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-110

Small Matrix Operation to Processor Code Replacement . . . . . . 68-111
Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-111
Programmatically Develop a Code Replacement Library . . . . . . . 68-113

Matrix Multiplication Operation to MathWorks BLAS Code
Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-117

Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-117
Programmatically Develop a Code Replacement Library . . . . . . . 68-119

Matrix Multiplication Operation to ANSI/ISO C BLAS Code
Replacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-125

Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-125

lxviii Contents



Programmatically Develop a Code Replacement Library . . . . . . . 68-127

Remap Operator Output to Function Input . . . . . . . . . . . . . . . . . . 68-132

Fixed-Point Operator Code Replacement . . . . . . . . . . . . . . . . . . . 68-134
Common Ways to Match Fixed-Point Operator Entries . . . . . . . . 68-134
Fixed-Point Numbers and Arithmetic . . . . . . . . . . . . . . . . . . . . . 68-135
Addition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-136
Subtraction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-136
Multiplication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-137
Division . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-137
Data Type Conversion (Cast) . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-138
Shift . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-138

Binary-Point-Only Scaling Code Replacement . . . . . . . . . . . . . . . 68-140
Programmatically Develop a Code Replacement Library . . . . . . . 68-141

Slope Bias Scaling Code Replacement . . . . . . . . . . . . . . . . . . . . . 68-145
Programmatically Develop a Code Replacement Library . . . . . . . 68-146

Net Slope Scaling Code Replacement . . . . . . . . . . . . . . . . . . . . . . 68-151
Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-151
Programmatically Develop a Code Replacement Library . . . . . . . 68-153

Equal Slope and Zero Net Bias Code Replacement . . . . . . . . . . . 68-158
Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-158
Programmatically Develop a Code Replacement Library . . . . . . . 68-160

Data Type Conversions (Casts) and Operator Code Replacement
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-164

Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-164
Programmatically Develop a Code Replacement Library . . . . . . . 68-166

Shift Left Operations and Code Replacement . . . . . . . . . . . . . . . . 68-170
Interactively Develop a Code Replacement Library . . . . . . . . . . . 68-170
Programatically Develop a Code Replacement Library . . . . . . . . 68-172

Optimize Generated Code By Developing and Using Code
Replacement Libraries - MATLAB® . . . . . . . . . . . . . . . . . . . . . . 68-175

Performance

Optimizations for Generated Code in Simulink Coder
69

Increase Code Generation Speed . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-3
Build a Model in Increments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-3
Build Large Model Reference Hierarchies in Parallel . . . . . . . . . . . 69-3
Minimize Memory Requirements During Code Generation . . . . . . . 69-4

lxix



Generate Only Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-4
Suppress Creation of a Code Generation Report . . . . . . . . . . . . . . . 69-4

Control Compiler Optimizations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-6

Optimization Tools and Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . 69-7
Use the Model Advisor to Optimize a Model for Code Generation . . 69-7
Design Tips for Optimizing Generated Code for Stateflow Objects

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-7
Additional Optimization Techniques . . . . . . . . . . . . . . . . . . . . . . . . 69-8

Control Memory Allocation for Time Counters . . . . . . . . . . . . . . . . 69-10

Execution Profiling for Generated Code . . . . . . . . . . . . . . . . . . . . . 69-11

Optimize Generated Code by Combining Multiple for Constructs
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-13

Subnormal Number Execution Speed . . . . . . . . . . . . . . . . . . . . . . . 69-16
Simulation Time With and Without Subnormal Numbers . . . . . . . . 69-17
Flush Subnormal Numbers to Zero . . . . . . . . . . . . . . . . . . . . . . . . 69-17

Remove Code From Floating-Point to Integer Conversions That
Wraps Out-of-Range Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-20

Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-20
Generate Code Without Optimization . . . . . . . . . . . . . . . . . . . . . . 69-21
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 69-21

Remove Code That Maps NaN to Integer Zero . . . . . . . . . . . . . . . . 69-23
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-23
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-23
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 69-24

Disable Nonfinite Checks or Inlining for Math Functions . . . . . . . 69-26

Fold Expressions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-31

Minimize Computations and Storage for Intermediate Results at
Block Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-35

Expression Folding . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-35
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-35
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-35
Enable Optimization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-36
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 69-36

Inline Invariant Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-38
Optimize Generated Code Using Inline Invariant Signals . . . . . . . 69-38

Inline Numeric Values of Block Parameters . . . . . . . . . . . . . . . . . . 69-41

Configure Loop Unrolling Threshold . . . . . . . . . . . . . . . . . . . . . . . . 69-46

Use memcpy Function to Optimize Generated Code for Vector
Assignments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-48

Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-48

lxx Contents



Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-49
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 69-50

Generate Target Optimizations Within Algorithm Code . . . . . . . . 69-51

Remove Code for Blocks That Have No Effect on Computational
Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-52

Eliminate Dead Code Paths in Generated Code . . . . . . . . . . . . . . . 69-55

Floating-Point Multiplication to Handle a Net Slope Correction . 69-58

Use Conditional Input Branch Execution . . . . . . . . . . . . . . . . . . . . 69-61

Optimize Generated Code for Complex Signals . . . . . . . . . . . . . . . 69-65

Speed Up Linear Algebra in Code Generated from a MATLAB
Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-67

Specify LAPACK Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-67
Write LAPACK Callback Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-67
Generate LAPACK Calls by Specifying a LAPACK Callback Class . . 69-68
Locate LAPACK Library in Execution Environment . . . . . . . . . . . . 69-69

Speed Up Matrix Operations in Code Generated from a MATLAB
Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-70

Specify BLAS Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-70
Write BLAS Callback Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-70
Generate BLAS Calls by Specifying a BLAS Callback Class . . . . . . 69-72
Locate BLAS Library in Execution Environment . . . . . . . . . . . . . . 69-72
Usage Notes and Limitations for OpenBLAS Library . . . . . . . . . . . 69-73

Speed Up Fast Fourier Transforms in Code Generated from a
MATLAB Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-74

Install an FFTW Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-74
Write FFT Callback Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-74
Generate FFTW Calls by Specifying an FFT Callback Class . . . . . . 69-75

Synchronize Multithreaded FFTW Planning in Code Generated from
a MATLAB Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-77

Prerequisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-77
Create a Model with a MATLAB Function Block That Calls an FFT

Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-77
Write Supporting C Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-78
Create an FFT Library Callback Class . . . . . . . . . . . . . . . . . . . . . . 69-78
Configure Code Generation Parameters and Build the Model . . . . 69-79

Control Memory Allocation for Variable-Size Arrays in a MATLAB
Function Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-81

Provide Upper Bounds for Variable-Size Arrays . . . . . . . . . . . . . . . 69-81
Disable Dynamic Memory Allocation for MATLAB Function Blocks

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-81
Modify the Dynamic Memory Allocation Threshold . . . . . . . . . . . . 69-81

Optimize Memory Usage for Time Counters . . . . . . . . . . . . . . . . . . 69-83

lxxi



Optimize Generated Code Using Boolean Data for Logical Signals
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-88

Reduce Memory Usage for Boolean and State Configuration
Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-91

Customize Stack Space Allocation . . . . . . . . . . . . . . . . . . . . . . . . . . 69-92

Optimize Generated Code Using memset Function . . . . . . . . . . . . 69-93

Vector Operation Optimization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-97

Enable and Reuse Local Block Outputs in Generated Code . . . . 69-100
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69-100
Generate Code Without Optimization . . . . . . . . . . . . . . . . . . . . . 69-100
Enable Local Block Outputs and Generate Code . . . . . . . . . . . . . 69-101
Reuse Local Block Outputs and Generate Code . . . . . . . . . . . . . . 69-102

Configuration in Embedded Coder
70

Set Hardware Implementation Parameters . . . . . . . . . . . . . . . . . . . . 70-2

Data Copy Reduction in Embedded Coder
71

Optimize Global Variable Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-2
Use Global to Hold Temporary Results . . . . . . . . . . . . . . . . . . . . . . 71-2
Minimize Global Data Access . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-6

Reuse Global Block Outputs in the Generated Code . . . . . . . . . . . 71-12

Virtualized Output Ports Optimization . . . . . . . . . . . . . . . . . . . . . . 71-15

Specify Buffer Reuse by Using Simulink.Signal Objects . . . . . . . . 71-17

Specify Buffer Reuse for MATLAB Function Blocks in a Path . . . . 71-23
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-23
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 71-23

Remove Data Copies by Reordering Block Operations in the
Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-25

Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-25
Generate Code without Optimization . . . . . . . . . . . . . . . . . . . . . . 71-25
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 71-27

Data Copy Reduction for Data Store Read and Data Store Write
Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-30

lxxii Contents



Reduce Data Copies for Bus Assignment Blocks . . . . . . . . . . . . . . 71-34
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-34
Generate Code Without Optimization . . . . . . . . . . . . . . . . . . . . . . 71-34
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 71-35

Optimize Generated Code by Using Signal Labels to Guide Buffer
Reuse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-37

Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-37
Generate Code Without Optimization . . . . . . . . . . . . . . . . . . . . . . 71-37
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . 71-38
Using Label-Based Reuse Versus Reusable Custom Storage Classes

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71-38

Execution Speed in Embedded Coder
72

Reduce Memory Usage for Signals . . . . . . . . . . . . . . . . . . . . . . . . . . 72-2

Remove Zero Initialization Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-3
Remove Zero Initialization Code for Internal Data . . . . . . . . . . . . . . 72-3
Remove Initialization Code from Root-Level Inports and Outports Set

to Zero . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-5
Additional Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-7

Simplify Multiply Operations in Array Indexing . . . . . . . . . . . . . . . . 72-8
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-8
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-8
Generate Code with Optimization . . . . . . . . . . . . . . . . . . . . . . . . . . 72-9

Replace boolean with Specific Integer Data Type . . . . . . . . . . . . . . 72-11
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-11
Generate Code That Contains the Default boolean Data Type . . . . 72-11
Generate Code That Contains the Target boolean Data Type . . . . . 72-12

Remove Code from Tunable Parameter Expressions That Saturate
Against Integer Overflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-14

Remove Code That Guards Against Division Exceptions for Integers
and Fixed-Point Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-17

Optimize Generated Code by Consolidating Redundant If-Else
Statements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-21

Optimize Generated Code for Fixed-Point Data Operations . . . . . 72-25

Optimize Generated Code By Developing and Using Code
Replacement Libraries - Simulink® . . . . . . . . . . . . . . . . . . . . . . 72-27

Improve Execution Efficiency by Reordering Block Operations in the
Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-48

lxxiii



Generate SIMD Code from Simulink Blocks . . . . . . . . . . . . . . . . . . 72-58
Blocks That Support SIMD Code Generation . . . . . . . . . . . . . . . . . 72-58
Generate SIMD Code Compared to Plain C Code . . . . . . . . . . . . . 72-59
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-61

Speed Up for-Loop Implementation in Code Generated by Using
parfor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-62

How parfor-Loops Improve Execution Speed . . . . . . . . . . . . . . . . . 72-62
When to Use parfor-Loops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-62
When Not to Use parfor-Loops . . . . . . . . . . . . . . . . . . . . . . . . . . . 72-62
Write Code by Using parfor-Loops . . . . . . . . . . . . . . . . . . . . . . . . 72-63

Memory Usage in Embedded Coder
73

Optimize Generated Code Using Minimum and Maximum Values
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-2
Configure Your Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-2
Optimize Generated Code Using Specified Minimum and Maximum

Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-3
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-6

Reduce Global Variables in Nonreusable Subsystem Functions . . . 73-8
Generate void-void Function . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-8
Generate Function with Arguments . . . . . . . . . . . . . . . . . . . . . . . . 73-9

Optimize Generated Code By Packing Boolean Data Into Bitfields
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-11

Optimize Generated Code By Passing Reusable Subsystem Outputs
as Individual Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-14

Convert Data Copies to Pointer Assignments . . . . . . . . . . . . . . . . . 73-18

Reuse Buffers of Different Sizes and Dimensions . . . . . . . . . . . . . 73-22

Remove Reset and Disable Functions from the Generated Code . 73-28
Example Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-28
Generate Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-29
Enable Optimization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-29

Optimize Speed and Size of Signal Processing Algorithm by Using
Fixed-Point Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73-31

Control Operator Type in Generated Code . . . . . . . . . . . . . . . . . . . 73-32

lxxiv Contents



Code Execution Profiling in Embedded Coder
74

Code Execution Profiling with SIL and PIL . . . . . . . . . . . . . . . . . . . . 74-2
Configure Code Execution Profiling . . . . . . . . . . . . . . . . . . . . . . . . 74-2
Control Profiling Granularity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-3

View and Compare Code Execution Times . . . . . . . . . . . . . . . . . . . . . 74-6
Run SIL Simulation That Generates Execution-Time Metrics . . . . . . 74-6
Code Execution Profiling Report . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-8
Compare Code Execution-Time Performance Against Baseline . . . 74-13
Visualize Task Scheduling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-14

Analyze Code Execution Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-15

Remove Instrumentation Overheads from Execution Time
Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-17

Approach for Estimating and Removing Instrumentation Overhead
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-17

Remove Instrumentation Overheads by Using target Package . . . . 74-18
Remove Instrumentation Overheads by Using Functions from
rtw.connectivity.Config . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-19

Retrieve Benchmark Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-20

Capture Main Profiling Metrics on Target Hardware . . . . . . . . . . . 74-22

Tips and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-24
Triggered Model Block . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-24
Outliers in Execution-Time Profiles . . . . . . . . . . . . . . . . . . . . . . . . 74-24
Hardware-Specific Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-25
Task Context Switching Due to Preemption . . . . . . . . . . . . . . . . . . 74-25
Subsystem Code Reuse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-25
Cannot Load Execution-Time Measurements from Previous Release

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74-25

Code Execution Profiling for MATLAB Coder
75

Execution Time Profiling for SIL and PIL . . . . . . . . . . . . . . . . . . . . . 75-2

Generate Execution Time Profile . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75-3

View Execution Times . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75-4

Analyze Execution Time Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75-7
Extract Execution Time Data for Kalman Estimator Code . . . . . . . . 75-7

lxxv



Verification

Simulation and Code Comparison in Simulink Coder
76

Simulation and Code Comparison . . . . . . . . . . . . . . . . . . . . . . . . . . . 76-2
Configure Signal Data for Logging . . . . . . . . . . . . . . . . . . . . . . . . . 76-2
Log Simulation Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76-3
Run Executable and Load Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76-4
Visualize and Compare Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76-5
Compare States for Simulation and Code Generation . . . . . . . . . . . 76-6

Code Tracing in Embedded Coder
77

Verify Generated Code by Using Code Tracing . . . . . . . . . . . . . . . . . 77-2
Traceable Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-2
Traceability in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-3
Traceability Tags . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-5
Operator Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-6
Traceability Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-7

Trace Simulink Model Elements in Generated Code . . . . . . . . . . . . 77-8
Code-to-Model Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-8
Model-to-Code Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-10

Trace Stateflow Elements in Generated Code . . . . . . . . . . . . . . . . . 77-12
Inline Traceability for Stateflow Elements . . . . . . . . . . . . . . . . . . . 77-12
Bidirectional Traceability for States and Transitions . . . . . . . . . . . 77-13
Bidirectional Traceability for State Transition Tables . . . . . . . . . . 77-15
Bidirectional Traceability for Truth Table Blocks . . . . . . . . . . . . . . 77-17
Bidirectional Traceability for Graphical Functions . . . . . . . . . . . . 77-19
Code-to-Model Traceability for Events . . . . . . . . . . . . . . . . . . . . . 77-19
Model-to-Code Traceability for Junctions . . . . . . . . . . . . . . . . . . . 77-20
Format of Traceability Comments for Stateflow Elements . . . . . . . 77-21

Link Generated Code to Requirements . . . . . . . . . . . . . . . . . . . . . . 77-24

Reload Existing Traceability Information . . . . . . . . . . . . . . . . . . . . 77-28

Customize Traceability Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-30
Generate a Traceability Matrix . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-31

Trace Generated Code to Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-33

Use Traceability in MATLAB Function Blocks . . . . . . . . . . . . . . . . . 77-35
Extent of Traceability in MATLAB Function Blocks . . . . . . . . . . . . 77-35
Traceability Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77-35
Using Traceability in a MATLAB Function Block . . . . . . . . . . . . . . 77-35

lxxvi Contents



Component Verification in Embedded Coder
78

Component Verification in Target Environment . . . . . . . . . . . . . . . . 78-2
Goals of Component Verification . . . . . . . . . . . . . . . . . . . . . . . . . . . 78-2
Run Component Tests . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78-4

Component Verification With a Real-Time Target
Environment in Embedded Coder

79
Real-Time Software Component Verification . . . . . . . . . . . . . . . . . . . 79-2

Numerical Equivalence Checking in Embedded Coder
80

SIL and PIL Simulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-2
What Are SIL and PIL Simulations? . . . . . . . . . . . . . . . . . . . . . . . . 80-2
Why Use SIL and PIL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-2
How SIL and PIL Simulations Work . . . . . . . . . . . . . . . . . . . . . . . . . 80-3
Comparison of SIL and PIL Simulations . . . . . . . . . . . . . . . . . . . . . 80-4
Code Interfaces for SIL and PIL . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-5
Scheduling Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-6
Imported Data and Function Definitions . . . . . . . . . . . . . . . . . . . . . 80-7

Choose a SIL or PIL Approach . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-11
Test Top-Model Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-12
Test Referenced Model Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-12
Test Subsystem Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-12
Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-13

Configure and Run SIL Simulation . . . . . . . . . . . . . . . . . . . . . . . . . 80-15
Simulation with Top Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-15
Simulation with Model Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-16
Simulation with Subsystem Blocks . . . . . . . . . . . . . . . . . . . . . . . . 80-17
Test Atomic Subsystem Generated Code . . . . . . . . . . . . . . . . . . . . 80-18
SIL or PIL Block Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-19
Configure Hardware Implementation Settings . . . . . . . . . . . . . . . 80-20
Log Signals of a Component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-22
Prevent Code Changes in Multiple Simulations . . . . . . . . . . . . . . . 80-23
Speed Up Testing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-24
Simulation with Function Calls . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-24

Configure and Run PIL Simulation . . . . . . . . . . . . . . . . . . . . . . . . . 80-26
Simulation with Top Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-26
Simulation with Model Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-27
Simulation with Subsystem Blocks . . . . . . . . . . . . . . . . . . . . . . . . 80-28
Test Atomic Subsystem Generated Code . . . . . . . . . . . . . . . . . . . . 80-29

lxxvii



SIL or PIL Block Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-30
Log Signals of a Component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-31
Prevent Code Changes in Multiple Simulations . . . . . . . . . . . . . . . 80-32
Speed Up Testing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-33
Simulation with Function Calls . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-33

Simulation Mode Override Behavior in Model Reference Hierarchy
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-35

Debug Generated Code During SIL Simulation . . . . . . . . . . . . . . . 80-37

Create PIL Target Connectivity Configuration for Simulink . . . . . 80-39
Target Connectivity Configurations for PIL . . . . . . . . . . . . . . . . . . 80-39
Create a Target Connectivity API Implementation . . . . . . . . . . . . . 80-39
Register a Connectivity API Implementation . . . . . . . . . . . . . . . . . 80-41
Verify Target Connectivity Configuration . . . . . . . . . . . . . . . . . . . 80-41
Target Connectivity API Examples . . . . . . . . . . . . . . . . . . . . . . . . 80-41

Host-Target Communication for Simulink PIL simulation . . . . . . . 80-43
Communications rtiostream API . . . . . . . . . . . . . . . . . . . . . . . . . . 80-43
Synchronize Host and Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-44
Test an rtiostream Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-44
Word Addressable Target Hardware . . . . . . . . . . . . . . . . . . . . . . . 80-44

Specify Hardware Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-46

Set Up PIL Connectivity by Using target Package . . . . . . . . . . . . . 80-49
Use rtiostream API for PIL Target Connectivity . . . . . . . . . . . . . . . 80-49
Use Debugger for PIL Target Connectivity . . . . . . . . . . . . . . . . . . 80-52
DebugIOTool Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-53

Custom Toolchain Directives Required for Code Coverage and
Execution Profiling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-59

PIL Simulation Sequence . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-60

Verification of Code Generation Assumptions . . . . . . . . . . . . . . . . . 80-62

View SIL and PIL Files in Code Generation Report . . . . . . . . . . . . 80-65

SIL/PIL Manager Verification Workflow . . . . . . . . . . . . . . . . . . . . . . 80-67
Open the App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-67
Select the Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-67
Prepare the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-67
Run Automated Verification, Model Simulation, or SIL/PIL Simulation

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-70
Analyze Results and Export Test Cases . . . . . . . . . . . . . . . . . . . . . 80-70

Security for PIL Simulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-73

SIL and PIL Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-74
About SIL and PIL Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-74
General SIL and PIL Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . 80-74
Top-Model SIL/PIL Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-81
Model Block SIL/PIL Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . 80-82

lxxviii Contents



Subsystem Block SIL/PIL Limitations . . . . . . . . . . . . . . . . . . . . . . 80-83

Test Generated Code with SIL and PIL Simulations . . . . . . . . . . . . 80-85

Create a Target Communication Channel for Processor-In-The-Loop
(PIL) Simulation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-99

Configure Processor-In-The-Loop (PIL) for a Custom Target . . . 80-104

Field-Oriented Control of Permanent Magnet Synchronous Machine
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-109

Check Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-126

Verify Numerical Equivalence with CGV . . . . . . . . . . . . . . . . . . . . 80-127

Verify Numerical Equivalence Between Two Modes of Execution of a
Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-128
Configure the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-128
Execute the Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-128
Compare All Output Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-129
Compare Individual Output Signals . . . . . . . . . . . . . . . . . . . . . . 80-130
Plot Output Signals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80-131

Numerical Consistency between Model and Generated
Code

81
Numerical Consistency of Model and Generated Code Simulation

Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81-2
Numerical Consistency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81-2
Numerical Consistency in Complex Systems . . . . . . . . . . . . . . . . . . 81-2
Reasons for Block-Level Numerical Differences . . . . . . . . . . . . . . . 81-4

Software-in-the-Loop Execution for MATLAB Coder
82

Code Verification Through Software-in-the-Loop and Processor-in-
the-Loop Execution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-2

Software-in-the-Loop Execution with the MATLAB Coder App . . . . 82-4

Software-in-the-Loop Execution From Command Line . . . . . . . . . . . 82-6
SIL Execution of Code Generated for a Kalman Estimator . . . . . . . . 82-6

Debug Generated Code During SIL Execution . . . . . . . . . . . . . . . . . 82-9

lxxix



Create PIL Target Connectivity Configuration for MATLAB . . . . . 82-11
Target Connectivity Configurations for PIL . . . . . . . . . . . . . . . . . . 82-11
Create a Target Connectivity API Implementation . . . . . . . . . . . . . 82-11
Register Target Connectivity Configuration . . . . . . . . . . . . . . . . . 82-13
Verify Target Connectivity Configuration . . . . . . . . . . . . . . . . . . . 82-13

Host-Target Communication for MATLAB PIL Execution . . . . . . . . 82-14
Communications rtiostream API . . . . . . . . . . . . . . . . . . . . . . . . . . 82-14
Synchronize Host and Target . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-15
Test an rtiostream Driver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-15

Specify Hardware Timer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-16

Custom Toolchain Directives Required for Code Execution Profiling
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-19

Processor-in-the-Loop Execution with the MATLAB Coder App . . 82-20

Processor-in-the-Loop Execution From Command Line . . . . . . . . . 82-22
PIL Execution of Code Generated for a Kalman Estimator . . . . . . . 82-22

Verification of Code Generation Assumptions . . . . . . . . . . . . . . . . . 82-26

SIL/PIL Execution Support and Limitations . . . . . . . . . . . . . . . . . . 82-27

Speed Up SIL/PIL Execution by Disabling Constant Input Checking
and Global Data Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . 82-29

Disable Constant Input Checking or Global Data Synchronization at
the Command Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-29

Disable Constant Input Checking or Global Data Synchronization in the
MATLAB Coder App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-29

SIL and PIL Verification for Deployment on Raspberry Pi . . . . . . . 82-30

Software-in-the-loop Execution For MATLAB Function with Multiple
Signatures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-36

Generate Multisignature SIL MEX File for an Entry-Point Function
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-36

Generate Multisignature SIL MEX File for Multiple Entry-Point
Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82-37

Code Coverage in Embedded Coder
83

Simulink Code Coverage Metrics . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-2
Statement Coverage for Code Coverage . . . . . . . . . . . . . . . . . . . . . 83-2
Condition Coverage for Code Coverage . . . . . . . . . . . . . . . . . . . . . . 83-2
Decision Coverage for Code Coverage . . . . . . . . . . . . . . . . . . . . . . 83-3
Modified Condition/Decision Coverage (MCDC) for Code Coverage

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-3
Cyclomatic Complexity for Code Coverage . . . . . . . . . . . . . . . . . . . 83-4
Relational Boundary for Code Coverage . . . . . . . . . . . . . . . . . . . . . 83-4

lxxx Contents



Code Coverage for Models in Software-in-the-Loop (SIL) Mode and
Processor-in-the-Loop (PIL) Mode . . . . . . . . . . . . . . . . . . . . . . . . . 83-5

Enable SIL or PIL Code Coverage for a Model . . . . . . . . . . . . . . . . 83-5
Review the Coverage Results for Models in SIL or PIL Mode . . . . . . 83-5
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-7

Configure Code Coverage with Third-Party Tools . . . . . . . . . . . . . . . 83-8

View Code Coverage Information at the End of SIL or PIL
Simulations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-10

View LDRA Testbed Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-10
View BullseyeCoverage Results . . . . . . . . . . . . . . . . . . . . . . . . . . 83-11

Configure Code Coverage Programmatically . . . . . . . . . . . . . . . . . . 83-13
Set Up Third Party Code Coverage From Command Line . . . . . . . 83-13
Code Coverage for Model That Uses Configuration Reference . . . . 83-14

Code Coverage Summary and Annotations . . . . . . . . . . . . . . . . . . . 83-15
LDRA Testbed Coverage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-15
BullseyeCoverage Information . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-18

Code Coverage Tool Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-21

Tips and Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-22
Model Build and SIL/PIL Blocks Not Supported . . . . . . . . . . . . . . 83-22
BullseyeCoverage License Wait . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-22
Current Working Folder Cannot be UNC Path . . . . . . . . . . . . . . . . 83-22
Characters in matlabroot and File Path . . . . . . . . . . . . . . . . . . . . . 83-22
Header Files with Identical Names . . . . . . . . . . . . . . . . . . . . . . . . 83-22
Code Coverage for Source Files in Shared Utility Folders . . . . . . . 83-22
BullseyeCoverage Behavior with Inline Macros . . . . . . . . . . . . . . . 83-22
SIL and PIL Simulations with Open LDRA Testbed . . . . . . . . . . . . 83-23
Minor SIL and PIL Differences for LDRA Testbed . . . . . . . . . . . . . 83-23
PIL Zero Coverage LDRA Testbed Annotations . . . . . . . . . . . . . . . 83-24
PIL Support for BullseyeCoverage . . . . . . . . . . . . . . . . . . . . . . . . 83-24
Modify Legacy Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83-24

Collect Code Coverage Metrics with a Third-Party Tool . . . . . . . . . 83-25

Embedded IDEs and Embedded Targets

Run-Time Data Interface Extensions in Simulink Coder
84

Customize Generated ASAP2 File . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84-2
About ASAP2 File Customization . . . . . . . . . . . . . . . . . . . . . . . . . . 84-2
ASAP2 File Structure on the MATLAB Path . . . . . . . . . . . . . . . . . . . 84-2
Customize the Contents of the ASAP2 File . . . . . . . . . . . . . . . . . . . 84-2
ASAP2 Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84-3

lxxxi



Customize Computation Method Names . . . . . . . . . . . . . . . . . . . . . 84-5
Suppress Computation Methods for FIX_AXIS . . . . . . . . . . . . . . . . . 84-5

Build Process Integration in Simulink Coder
85

Control Build Process Compiling and Linking . . . . . . . . . . . . . . . . . 85-2

Control Library Location and Naming During Build . . . . . . . . . . . . 85-3
Library Control Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-3
Specify the Location of Precompiled Libraries . . . . . . . . . . . . . . . . 85-4
Location of Model Reference Libraries . . . . . . . . . . . . . . . . . . . . . . 85-5
Control the Suffix Applied to Library File Names . . . . . . . . . . . . . . 85-5

Recompile Precompiled Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-7

Customize Post-Code-Generation Build Processing . . . . . . . . . . . . . 85-8
Workflow for Setting Up Customizations . . . . . . . . . . . . . . . . . . . . . 85-8
Build Information Object . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-8
Program a Post Code Generation Command . . . . . . . . . . . . . . . . . . 85-9
Define a Post Code Generation Command . . . . . . . . . . . . . . . . . . . 85-10
Customize Build Process with PostCodeGenCommand and Relocate

Generated Code to an External Environment . . . . . . . . . . . . . . 85-10
Suppress Makefile Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-12

Configure Generated Code with TLC . . . . . . . . . . . . . . . . . . . . . . . . 85-13
Assigning Target Language Compiler Variables . . . . . . . . . . . . . . . 85-13
Set Target Language Compiler Options . . . . . . . . . . . . . . . . . . . . . 85-15

Use makecfg to Customize Generated Makefiles for S-Functions
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-16

Use rtwmakecfg.m API to Customize Generated Makefiles . . . . . . 85-18
About the rtwmakecfg Function . . . . . . . . . . . . . . . . . . . . . . . . . . 85-18
Create the rtwmakecfg Function . . . . . . . . . . . . . . . . . . . . . . . . . 85-18
Modify the Template Makefile for rtwmakecfg . . . . . . . . . . . . . . . 85-20

Register Custom Toolchain and Build Executable . . . . . . . . . . . . . 85-22

Customize Build Process with STF_make_rtw_hook File . . . . . . . . 85-36
STF_make_rtw_hook File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-36
Conventions for Using the STF_make_rtw_hook File . . . . . . . . . . . 85-36
STF_make_rtw_hook.m Function Prototype and Arguments . . . . . 85-36
Applications for STF_make_rtw_hook.m . . . . . . . . . . . . . . . . . . . . 85-38
Control Code Regeneration Using STF_make_rtw_hook.m . . . . . . 85-38
Use STF_make_rtw_hook.m for Your Build Procedure . . . . . . . . . . 85-39
Hook Method after_tlc . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-39

Customize Build Process with sl_customization.m . . . . . . . . . . . . . 85-40
The sl_customization.m File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-40
Register Build Process Hook Functions Using sl_customization.m

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-41

lxxxii Contents



Variables Available for sl_customization.m Hook Functions . . . . . . 85-42
Example of Build Process Customization with sl_customization.m

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85-42

Replace STF_rtw_info_hook Supplied Target Data . . . . . . . . . . . . . 85-44

Custom Target Development in Simulink Coder
86

Custom Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-2

Sample Custom Targets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-3

Target Development Folders, Files, and Builds . . . . . . . . . . . . . . . . . 86-5
Folder and File Naming Conventions . . . . . . . . . . . . . . . . . . . . . . . 86-5
Components of a Custom Target . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-5
Key Folders Under Target Root (mytarget) . . . . . . . . . . . . . . . . . . . 86-9
Key Files in Target Folder (mytarget/mytarget) . . . . . . . . . . . . . . . 86-11
Additional Files for Externally Developed Targets . . . . . . . . . . . . . 86-13
Target Development and the Build Process . . . . . . . . . . . . . . . . . . 86-13

Customize System Target Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-18
Control Code Generation With the System Target File . . . . . . . . . . 86-18
System Target File Naming and Location Conventions . . . . . . . . . 86-18
System Target File Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-18
Define and Display Custom Target Options . . . . . . . . . . . . . . . . . . 86-24
Tips and Techniques for Customizing Your System Target File . . . 86-29
Create a Custom Target Configuration . . . . . . . . . . . . . . . . . . . . . 86-32

Customize Template Makefiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-43
Template Makefiles and Tokens . . . . . . . . . . . . . . . . . . . . . . . . . . 86-43
Invoke the make Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-48
Structure of the Template Makefile . . . . . . . . . . . . . . . . . . . . . . . . 86-49
Customize and Create Template Makefiles . . . . . . . . . . . . . . . . . . 86-51

Custom Target Optional Features . . . . . . . . . . . . . . . . . . . . . . . . . . 86-56

Support Toolchain Approach with Custom Target . . . . . . . . . . . . . 86-58

Support Model Referencing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-60
Requirements for Model Referencing with a Custom System Target

File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-60
Declaring Model Referencing Compliance . . . . . . . . . . . . . . . . . . 86-60
Providing Model Referencing Support in the TMF . . . . . . . . . . . . . 86-60
Controlling Configuration Option Value Agreement . . . . . . . . . . . . 86-63
Preventing Resource Conflicts (Optional) . . . . . . . . . . . . . . . . . . . 86-63

Support Compiler Optimization Level Control . . . . . . . . . . . . . . . . 86-65
About Compiler Optimization Level Control and Custom Targets . . 86-65
Declaring Compiler Optimization Level Control Compliance . . . . . 86-65
Providing Compiler Optimization Level Control Support in the Target
Makefile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-66

lxxxiii



Support C Function Prototype Control . . . . . . . . . . . . . . . . . . . . . . 86-67
About C Function Prototype Control and Custom Targets . . . . . . . 86-67
Declaring C Function Prototype Control Compliance . . . . . . . . . . . 86-67
Providing C Function Prototype Control Support in the Custom Static

Main Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-68

Support C++ Class Interface Control . . . . . . . . . . . . . . . . . . . . . . . 86-69
About C++ Class Interface Control and Custom Targets . . . . . . . . 86-69
Declaring C++ Class Interface Control Compliance . . . . . . . . . . . 86-69
Providing C++ Class Interface Control Support in the Custom Static

Main Program . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-69

Support Concurrent Execution of Multiple Tasks . . . . . . . . . . . . . . 86-71

Device Drivers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86-72

Build Configurations for Embedded Targets in Embedded
Coder

87
Model Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87-2

Block Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87-2
Configure Target Hardware Resources . . . . . . . . . . . . . . . . . . . . . . 87-2

Processor-Specific Optimizations for Embedded Targets in
Embedded Coder

88
Replace Code for Embedded Targets . . . . . . . . . . . . . . . . . . . . . . . . . 88-2

Using a Processor-Specific Code Replacement Library to Optimize
Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88-2

Process of Determining Optimization Effects Using Real-Time Profiling
Capability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88-2

Code Generation from MATLAB Code

Build Configuration for Code Generation from MATLAB
Code

89
Specify Comment Style for C/C++ Code . . . . . . . . . . . . . . . . . . . . . . 89-2

Specify Comment Style Using the MATLAB Coder App . . . . . . . . . . 89-2

lxxxiv Contents



Specify Comment Style Using the Command-Line Interface . . . . . . 89-2

Specify Indent Style for C/C++ Code . . . . . . . . . . . . . . . . . . . . . . . . . 89-4
Specify Indent Style Using the MATLAB Coder App . . . . . . . . . . . . 89-4
Specify Indent Style Using the Command-Line Interface . . . . . . . . . 89-5

Generate Custom File and Function Banners for C/C++ Code . . . . 89-6

Code Generation Template Files for MATLAB Code . . . . . . . . . . . . . 89-9
Default CGT File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-9
CGT File Structure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-9
Components of the CGT File Sections . . . . . . . . . . . . . . . . . . . . . . 89-10

Customize Generated Identifiers . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-18
Customize Identifiers by Using the MATLAB Coder App . . . . . . . . 89-18
Customize Generated Identifiers by Using the Command-Line Interface

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-19

Customize C/C++ File Names Generated from MATLAB Code . . . 89-20
Customize File Names by Using the MATLAB Coder App . . . . . . . 89-20
Customize Generated File Names by Using the Command-Line

Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-20

Control Signed Left Shifts in Generated Code . . . . . . . . . . . . . . . . 89-22
Control Signed Left Shifts Using the MATLAB Coder App . . . . . . . 89-22
Control Signed Left Shifts Using the Command-Line Interface . . . 89-22

Control Data Type Casts in Generated Code . . . . . . . . . . . . . . . . . . 89-23
Specify Casting Mode Using the MATLAB Coder App . . . . . . . . . . 89-24
Specify Casting Mode Using the Command-Line Interface . . . . . . 89-24

Simplify Multiply Operations for Array Indexing in Loops . . . . . . 89-26

Generate SIMD Code for MATLAB Functions . . . . . . . . . . . . . . . . . 89-27
MATLAB Functions That Support SIMD Code . . . . . . . . . . . . . . . . 89-27
Generate SIMD Code Versus Plain C Code . . . . . . . . . . . . . . . . . . 89-28
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-30

Generate C/C++ Code with Improved MISRA Compliance . . . . . . 89-31
Configure Code Generation Configuration Object Properties . . . . . 89-31
Configure MATLAB Coder App Settings . . . . . . . . . . . . . . . . . . . . 89-32
Additional Settings for MISRA C++ Compliance . . . . . . . . . . . . . . 89-32

Customize Data Type Replacement . . . . . . . . . . . . . . . . . . . . . . . . . 89-34
Specify Custom Data Type Names by Using the MATLAB Coder App

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-34
Specify Custom Data Type Names by Using the Command-Line

Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-35

Import Custom Data Type Definitions from External Header Files
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-36

Import Custom Types by Using the MATLAB Coder App . . . . . . . . 89-36
Import Custom Types by Using the Command-Line Interface . . . . 89-37

lxxxv



MATLAB Code Patterns That Require a Nonempty Initialize Function
in Generated Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-38

Issue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-38
Solution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89-38

Storage Classes for Code Generation from MATLAB Code
90

Storage Classes for Code Generation from MATLAB Code . . . . . . . 90-2

Control Declarations and Definitions of Global Variables in Code
Generated from MATLAB Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90-4

Verification of Code Generated from MATLAB Code
91

Highlight Potential Data Type Issues in a Report . . . . . . . . . . . . . . . 91-2
Enable Highlight Option Using the MATLAB Coder App . . . . . . . . . 91-2
Enable Highlight Option Using the Command Line Interface . . . . . . 91-2

Find Potential Data Type Issues in Generated Code . . . . . . . . . . . . . 91-4
Data Type Issues Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-4
Enable Highlighting of Potential Data Type Issues . . . . . . . . . . . . . 91-4
Find and Address Cumbersome Operations . . . . . . . . . . . . . . . . . . . 91-5
Find and Address Expensive Rounding . . . . . . . . . . . . . . . . . . . . . . 91-5
Find and Address Expensive Comparison Operations . . . . . . . . . . . 91-6
Find and Address Multiword Operations . . . . . . . . . . . . . . . . . . . . . 91-7

PIL Execution with ARM Cortex-A at the Command Line . . . . . . . . 91-9

PIL Execution with ARM Cortex-A by Using the MATLAB Coder App
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-11

Interactively Trace Between MATLAB Code and Generated C/C++
Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-12

Create the MATLAB Source Code . . . . . . . . . . . . . . . . . . . . . . . . . 91-12
Prepare for Code Generation . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-15
Produce a Code Generation Report with Traceability . . . . . . . . . . 91-16
Access Trace Mode in the Report . . . . . . . . . . . . . . . . . . . . . . . . . 91-16
Trace Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-17
View Multiple Traces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-19
View Traces to Different Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-19
Switch the Locations of the Source and Generated Code . . . . . . . . 91-20
Enable Code Tooltips and Links . . . . . . . . . . . . . . . . . . . . . . . . . . 91-20
Disable Traceability . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-21

Polyspace Verification of C/C++ Code Generated by MATLAB Coder
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-22

Run Polyspace Analysis in the MATLAB Coder App . . . . . . . . . . . . 91-22

lxxxvi Contents



Run Polyspace Analysis on Code Generated by codegen . . . . . . . . 91-22
Review Analysis Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91-22

lxxxvii





Model Architecture and Design

89





Modeling Environment for Embedded
Coder

• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “Model Single-Core, Single-Tasking Platform Execution” on page 1-12
• “Model Single-Core, Multitasking Platform Execution” on page 1-15
• “Model Concurrent Execution for Symmetric Multicore CPU Platforms” on page 1-18
• “Model Explicit Function Invocation with Atomic Subsystems” on page 1-23
• “Model Explicit Function Invocation with Function-Call Subsystems” on page 1-26

1



Design Models for Generated Embedded Code Deployment
When using Embedded Coder to generate code for an embedded system architecture, it is important
to design your Simulink models with code generation in mind from the very beginning of the design
process. Think about relevant design factors and issues such as:

Application Algorithms and Run-Time Environments
Use Simulink to design models that represent application algorithms and run-time environments from
which you intend to generate deployable code. Depending on your application, you might deploy code
to an execution environment that consists of a combination of:

Execution Environment
Components

Choices

Hardware • Development computer
• Rapid-prototyping board
• Microprocessor
• Microcontroller
• FPGA
• ASIC

Cores • Single
• Multiple

Operating system • General-purpose
• Real-time
• None (bare metal)

Scheduling • Single-tasking
• Multitasking
• Interrupt driven
• Concurrency
• Provided by operating system
• Generated from model

Application algorithm code • Generated from model
• External code

As you design models to generate C or C++ code for rapid prototyping or production deployment,
keep in mind the execution environment. Generate code that meets implementation requirements and
avoids potential design rework. As the preceding table reflects, the execution environment for code
that you generate can range from relatively simple to complex. For example, a simple case is code
that you generate from a single, single-tasking model that runs on a single-core microprocessor. A
complex case is code that is generated from a model partitioned to run as a distributed system on a
multicore microprocessor and an FPGA.

1 Modeling Environment for Embedded Coder
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Software Execution Framework for Generated Code
Part of an application execution environment is the software execution framework that is responsible
for scheduling and running the generated code. That software can preexist, as in the case of an
operating system and its scheduler, or you can code the software manually. The level of complexity
varies depending on which of the following modeling and code generation scenarios applies:

• Generate code from a single top model, which represents the algorithms intended to run in the
execution environment.

• Generate code from a model, which represents part of an overall algorithm. You can mix the
generated code with code written manually and code generated from other sources or releases of
MathWorks® products.

Single Top Model

For a single top model, the software execution framework is responsible for running generated code
the same way that Simulink simulates the model. Functions in the generated code are highly
coordinated and optimized because Simulink is aware of dependencies. The framework interfaces
with code generated for the top model only. Code generated for a top model handles interfacing with
code for referenced Model blocks.

Consider the following example, where a single top model is mapped to tasks that run on a single-
core CPU.

For this system, you map model clock rates to tasks that run on the hardware. You can choose for
Simulink to map the rates implicitly or you can map them explicitly in your model. You can model
latency effects resulting from how you map rates in a model to single-tasking or multitasking
execution environments. Simulink schedules the tasks properly based on rates in the model and data
dependencies between tasks. The code generator implements the same dependencies in the code that
it generates. The software execution framework invokes generated entry-point functions at rates
based on system timers and interrupts. The generated code executes in the same manner that
Simulink simulates the model, and contains code dedicated to communicating data between functions
running at different rates.

Multiple Top-Level Models

When you generate code from multiple top models separately and mix that code with code acquired
in other ways, the execution environment of the application takes on more software execution
framework responsibility. For this modeling scenario, you generate code for standalone, atomic
reusable components.
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With this scenario, Simulink is not aware of model dependencies. Functions in code generated from
the different models are minimally coordinated and optimized. For example, the models might share
generated utility functions. Potential optimizations that cross model boundaries are not possible. You
must design the software execution framework taking into account dependencies between units of
code, including execution order. For an application that requires concurrent execution across multiple
cores, you must consider data latency effects across the cores.

The code generator helps you address software execution framework challenges, such as sharing
global data and avoiding identifier conflicts. The code generated for each model handles the
interfacing for referenced Model blocks.

Map Embedded System Architecture to Simulink Modeling
Environment
When mapping an embedded system architecture to the Simulink modeling environment, think about
the model design.

“Modeling
Algorithms” on
page 1-5

Given initial state and input, a set of tasks or instructions that efficiently
produce the results that you want.

“Modeling
Interfaces” on page
1-5

Mechanisms that enable algorithm components to communicate and exchange
information across component boundaries.

“Modeling Systems”
on page 1-7

Collection of algorithm components that achieve a higher-level, domain-specific
goal or result. Components often share resources.

“Modeling Run-
Time
Environments” on
page 1-8

Framework that handles scheduling of system algorithm resources and
execution.

Consider the following questions regarding an embedded system architecture with corresponding
modeling capabilities and links to related information. Use the information as a guide for mapping
your architecture details to the Simulink modeling environment. Designing a model architecture with
your specific embedded system architecture in mind can help you avoid rework and future conversion
and maintenance costs.

1 Modeling Environment for Embedded Coder
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Modeling Algorithms

Architecture Considerations Modeling
Considerations

Related Information

What is the system domain? Product prerequisites
(based on domains of
components)

• “Blocks and Products Supported for
Code Generation”

• “Simulink Control Design”
• “Signal Processing”
• “Signal Generation, Manipulation, and

Analysis” (DSP System Toolbox)
Does the system involve physical
domains, such as mechanical,
electrical, or hydraulic domains?

Physical systems • “Physical Modeling”
• “Basic Principles of Modeling Physical

Networks” (Simscape)
• “Essential Physical Modeling

Techniques” (Simscape)
What aspects of your algorithm can
you represent with blocks provided by
MathWorks products? What blocks do
you need to create?

Block usage, creation, and
customization

• “Blocks and Products Supported for
Code Generation”

• “External Code Integration”

Does the architecture include state
machine components?

Event-driven system “Model Reactive Systems in Stateflow”
(Stateflow)

Is there a need to standardize code
that the code generator produces from
multiple models?

Custom code definitions
for data and functions

• “Define Storage Classes, Memory
Sections, and Function Templates for
Software Architecture” on page 31-2

• Embedded Coder Dictionary

Modeling Interfaces

Architecture Considerations Modeling
Considerations

Related Information

• What data must you represent in
the generated code?

• How do you need to represent input
and output—data type, dimension,
complexity?

• Do the algorithms use floating-point
or fixed-point arithmetic?

• How will the data change?

Data representation • “Define Interfaces of Model
Components”

• “Data Representation and Access”
• “Modeling Patterns for C Code”
• “Fixed-Point Designer”

Where and how is data pulled into the
system and pulled within the system?

Input “Comparison of Signal Loading
Techniques”

• Where and how is data pushed
within the system and out of the
system?

• What external triggers are
required?

Output • “View Data in the Simulation Data
Inspector”

• “Organize Parameter Data into a
Structure by Using Struct Storage
Class” on page 33-68
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Architecture Considerations Modeling
Considerations

Related Information

• What functions do you need to
define for each component?

• What is the prototype for each
entry-point function?

Functions and function
calls

• “Configure C Code Generation for
Model Entry-Point Functions” on page
33-112

• “Interactively Configure C++
Interface” on page 42-2

Can you benefit from setting up default
code generation configurations for
categories of data and functions?

Data and function
configuration

• “Configure Default C Code Generation
for Categories of Data Elements and
Functions” on page 33-15

• Code Mappings editor
Do you need to export functions that
are invoked by controlling logic that is
outside the model?

Function export • “Export-Function Models Overview”
• “Generate Component Source Code for

Export to External Code Base” on page
56-47

Does the system monitor signals or log
data (for example, for calibration)?

C API and ASAP2 data
exchange interfaces

• “Exchange Data Between Generated
and External Code Using C API”

• “Export ASAP2 File for Data
Measurement and Calibration”

Do you need to replace code generated
for functions or operators, for example,
to optimize the code for specific
hardware?

Code replacement • “What Is Code Replacement?”
• “What Is Code Replacement

Customization?” on page 67-3

Do you need to control the placement
of data or functions in memory?

Memory sections “Control Data and Function Placement in
Memory by Inserting Pragmas” on page
43-2

Is there a requirement for elaboration
and future considerations?

Elaboration and future
considerations

“Define Interfaces of Model Components”

1 Modeling Environment for Embedded Coder

1-6



Modeling Systems

Architecture Considerations Modeling
Considerations

Related Information

• What is the scope of the system?
Controller? External environment
or plant? Test harness?

• How is the system partitioned into
algorithm components (chunks of
logic)?

• Which components can you
represent in Simulink?

• Can you design components for
reuse? What is the motivation for
reuse (for example, division of labor
or plug-n-play)?

Componentization • “Define Interfaces of Model
Components”

• “Component-Based Modeling
Guidelines”

• “Compare Capabilities of Model
Components”

• “Create Custom Library”
• “Export-Function Models Overview”
• “Integrate Basic Algorithms Using

MATLAB Function Block”
• “Control Generation of Functions for

Subsystems”
• “Generate Code for Model Reference

Hierarchy”
• “Code Generation of Stateflow Blocks”

• Do aspects of the system require
unit testing?

• Is a team of people collaborating on
the project?

• Do you need to protect intellectual
property?

Model referencing • “Model Reference Basics”
• “Compare Capabilities of Model

Components”
• “Generate Code for Model Reference

Hierarchy”
• “Generate Code from Atomic

Subcharts”
Are you modeling a client-server
architecture?

Simulink Function and
Caller blocks

• “Client-Server Architecture”
• “Simulink Functions Overview”

Is relevant legacy or custom code
available?

External code integration “External Code Integration”

Can you apply a reference architecture
or reference components?

Model and project
templates

• “Create Template from Model”
• “Create a New Project Using

Templates”
Do you need to export functions that
are invoked by controlling logic that is
outside a model?

Export-function models “Export-Function Models Overview”

Is there a need to package the source
code for a component as a shared
object library to simplify distribution or
sharing?

Shared object libraries
(dynamic link libraries)

“Package Generated Code as Shared
Libraries” on page 64-2
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Architecture Considerations Modeling
Considerations

Related Information

Can you reuse functions? Function reuse • “Generate Reusable Code from Library
Subsystems Shared Across Models”

• “Generate Reusable Code from Library
Subsystems Shared Across Models”

• “Generate Reentrant Code from Top
Models”

• “Generate Reentrant Code from
Subsystems”

• Do components need to share
access to global data?

• Within the system, do state changes
occur? In each case, how does the
result get communicated?

• Are there identifier (naming) issues
to consider?

Shared data • “Local and Global Data Stores”
• “Data Structures in the Generated

Code” on page 34-31
• “Storage Classes for Parameters and

Signals Used in Model Blocks”
• “Code Generation of Constant

Parameters”
• “Data Stores in Generated Code”
• “Customize Generated Identifier

Naming Rules” on page 53-10
Do you need to control placement of
data or functions in memory?

Memory sections “Control Data and Function Placement in
Memory by Inserting Pragmas” on page
43-2

Are you required to apply the
AUTOSAR standard? If yes, what
aspects of the architecture involve
AUTOSAR?

AUTOSAR “AUTOSAR Blockset”

Does your system need to meet other
standards or guidelines?

Standards and guidelines “Support for Standards and Guidelines” on
page 23-2

Modeling Run-Time Environments

Architecture Considerations Modeling
Considerations

Related Information

• What level of control over run-time
interfacing does your application
require?

• How much of your system can you
represent in a model?

Runtime interfacing • “Execution of Code Generated from a
Model”

• See Modeling Interfaces.

Is the system partitioned into
concurrent components to maximize
parallelism? Which components?

Concurrency “Multicore Processor Targets”
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Architecture Considerations Modeling
Considerations

Related Information

• Are components driven by an
external clock?

• What clock rates do system
components use?

• Do components use a single rate or
multiple rates?

Clocks and clock rates “Define Interfaces of Model Components”

• Are components in the system
driven by clocks?

• What clock rates do system
components use?

• Do components use a single rate or
multiple rates?

• What are the priorities of system
tasks and functions?

Time-based scheduling • “Absolute and Elapsed Time
Computation”

• “Time-Based Scheduling”

• Are components in the system
driven by events (interrupts)?

• What are the priorities of system
tasks and functions?

Event-based scheduling • “Absolute and Elapsed Time
Computation”

• “Event-Based Scheduling”
• “Model Reactive Systems in Stateflow”
(Stateflow)

Does the system need to handle
initialization, reset, or terminate
events?

Initialization, reset,
termination

• “Using Initialize, Reset, and Terminate
Functions”

• “Generate Code That Responds to
Initialize, Reset, and Terminate Events”

• Is the system a single-tasking or
multitasking system?

• Are components required to
execute in real time?

• What are the execution order
dependencies (sequencing)
between components?

• What are the time constraints for
task and function execution?

Task execution • “Execution of Code Generated from a
Model”

• “Modeling for Single-Tasking
Execution”

• “Modeling for Multitasking Execution”
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Architecture Considerations Modeling
Considerations

Related Information

• If you know the processing
platform, what is it?

• Will the system run on a single-core
or multicore processor?

• Is the system a distributed system?
• Is the processing platform hybrid or

heterogeneous?
• Does the architecture employ

symmetric or asymmetric
multiprocessing? If asymmetric,
how is the platform software
partitioned across CPUs?

Processing platforms “Multicore Processor Targets”

• Do you want to generate and run a
standalone executable that does not
require an external real-time kernel
or operating system?

• Is a real-time operation system
(RTOS) required? If yes, what
RTOS?

Kernel, operating system • “Deploy Generated Standalone
Executable Programs To Target
Hardware” on page 66-2

• “Deploy Generated Component
Software to Application Target
Platforms” on page 66-26

Model Templates for Code Generation
Embedded Coder provides a set of built-in templates to use as a starting point to create models for
common application designs. Use the templates to create models that are preconfigured to generate
code for embedded system applications.

Template Description
Code Generation
System

Basic model consisting of an Inport block and Output block.

Exported functions Model for generating code from function-call subsystems. You can export each
function-call subsystem separately by right-clicking a subsystem, selecting C/C
++ Code > Export Functions, and clicking Build.

Fixed-step, multirate Fixed-step model that uses multiple rates and consists of Inport blocks, an
Outport block, and a Sum block. The model is configured to use a fixed-step
discrete solver and to use two rates with model configuration parameter
Periodic sample time constraint set to Unconstrained and parameter
Treat each discrete rate as a separate task selected. Simulink inserts a
Rate Transition block to handle the two sample rates.

Fixed-step, single
rate

Fixed-step model that uses a single rate and consists of Inport blocks, an
Outport block, and a Sum block. The model is configured to use a fixed-step
discrete solver.

To create a model from a template:

1 On the MATLAB® home tab, click Simulink.

1 Modeling Environment for Embedded Coder
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2 In the Simulink start page, expand Embedded Coder.
3 Hover over a template and click Create Model. A new model that uses the template contents

and settings appears in the Simulink Editor window.

For more information, for example to create and use a template as a reference design, see “Create
Template from Model”.

See Also

More About
• “Model Single-Core, Single-Tasking Platform Execution” on page 1-12
• “Model Single-Core, Multitasking Platform Execution” on page 1-15
• “Model Concurrent Execution for Symmetric Multicore CPU Platforms” on page 1-18
• “Model Explicit Function Invocation with Atomic Subsystems” on page 1-23
• “Model Explicit Function Invocation with Function-Call Subsystems” on page 1-26
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Model Single-Core, Single-Tasking Platform Execution
This example shows a model designed and configured for embedded system code generation intended
to execute on a single-core, single-tasking platform. The application algorithm is captured in a single
model hierarchy, making it possible to use Simulink® time-based, single-task scheduling to simulate
the model and execute the generated code.

Periodic Multirate Model Set Up for Single-Tasking Execution

Open the example model rtwdemo_multirate_singletasking. The model is configured to display color-
coded sample times with annotations. To see them, after opening the model, update the diagram by
pressing Ctrl+D. To display the legend, press Ctrl+J.

• Sample times for Inport blocks In1_1s and In2_2s are set to 1 and 2 seconds, respectively.
• To provide clean partitioning of rates, sample times for subsystems SS1 and SS2 are set to 1.

Relevant Model Configuration Parameter Settings

• Type set to Fixed-step.
• Solver set to discrete (no continuous states).
• Treat each discrete rate as a separate task cleared.

Scheduling

Simulink® simulates the model based on the model configuration. Code generated from the model
implements the same execution semantics. Simulink propagates and uses the Inport block sample
times to order block execution based on a single-core, single-tasking execution platform.

For this model, the sample time legend shows an implicit rate grouping. Red represents the fastest
discrete rate. Green represents the second fastest discrete rate.

The generated code schedules subrates in the model. In this example, the rate for Inport block
In2_2s, the green rate, is a subrate. The generated code properly transfers data between tasks
running at the different rates.

1 Modeling Environment for Embedded Coder
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Benefits of implicit rate grouping:

• Simulink does not impose architectural constraints on the model.
• Your execution framework does not require details about underlying function scheduling and data

transfers between rates. Therefore, the model interface requirements are simplified. The
execution framework uses generated interface code to write input, call the model step function,
and read output.

• The code generator optimizes code across rates based on single-tasking execution semantics.

Your execution framework can communicate with external devices for reading and writing model
input. For example, model external devices by using Simulink S-Function blocks. Generate code for
those blocks with the rest of the algorithm.

Generate Code and Report

Open the Embedded Coder app. Then, generate code and a code generation report. The example
model generates a report.

Review Generated Code

From the code generation report, review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code
controls model code execution by calling the entry-point function
rtwdemo_multirate_singletasking_step. Use this file as a starting point for coding your
execution framework.

• rtwdemo_multirate_singletasking.c contains entry points for the code that implements the
model algorithm. This file includes the rate scheduling code.

• rtwdemo_multirate_singletasking.h declares model data structures and a public interface
to the model entry points and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework:

1 Include the generated header file by adding directive #include
rtwdemo_multirate_singletasking.h.

2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:

• rtU.In1_1s of data type real_T with dimension of 1
• rtU.In2_2s of data type real_T with dimension of 1

Entry-point functions:

• Initialization entry-point function, void
rtwdemo_multirate_singletasking_initialize(void). At startup, call this function once.
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• Output and update entry-point (step) function, void
rtwdemo_multirate_singletasking_step(void). Call this function periodically at the
fastest rate in the model. For this model, call the function every second. To achieve real-time
execution, attach this function to a timer.

Output ports:

• rtY.Out1 of data type real_T with dimension of 1
• rtY.Out2 of data type real_T with dimension of 1

More About

• “Modeling for Single-Tasking Execution”
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
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Model Single-Core, Multitasking Platform Execution
Use Simulink® time-based, multitask scheduling to simulate and generate code for an application
algorithm captured in a single model hierarchy. The model is designed and configured for an
embedded system intended to execute on a single-core, multitasking platform. The model simulates
and the generated code executes based on the model configuration and a rate monotonic scheduling
algorithm.

Periodic Multirate Model Set Up for Multitasking Execution

Open the example model rtwdemo_multirate_multitasking. The model is configured to display
color-coded sample times with annotations. To see them, after opening the model, update the diagram
by pressing Ctrl+D. To display the legend, press Ctrl+J.

• Sample times for Inport blocks In1_1s and In2_2s are set to 1 and 2 seconds, respectively.
• To provide a clear partitioning of rates, sample times for subsystems SS1 and SS2 are set to 1.
• The Rate Transition block models an explicit rate transition. Alternatively, instruct Simulink to

insert Rate Transition blocks for you by selecting model configuration parameter Automatically
handle rate transition for data transfer.

Relevant Model Configuration Parameter Settings

• Type set to Fixed-step.
• Solver set to discrete (no continuous states).
• Treat each discrete rate as a separate task selected.

Scheduling

Simulink® simulates the model based on the model configuration. Code that this model generates
implements the same execution semantics. Simulink propagates and uses the Inport block sample
times to order block execution based on a single-core, multitasking execution platform.

For this model, the sample time legend shows an implicit rate grouping. Red represents the fastest
discrete rate. Green represents the second fastest discrete rate. Yellow represents the mixture of the
two rates.
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The generated code schedules subrates in the model. In this example, the rate for Inport block
In2_2s, the green rate, is a subrate. The generated code properly transfers data between tasks that
run at the different rates.

Benefits of implicit rate grouping:

• Simulink does not impose architectural constraints on the model. Create a model without
imposing software architecture constraints within the model.

• Your execution framework does not require details about underlying function scheduling and data
transfers between rates. Therefore, the model interface requirements are simplified. The
execution framework uses generated interface code to write input, call the model step function,
and read output.

• The code generator optimizes code across rates based on multitasking execution semantics.

Simulink enforces data transfer constraints to achieve rate-monotonic scheduling:

• Data transfers occur between a single read task and a single write task.
• When data transfers between two tasks, only one task can preempt the other task.
• For periodic tasks, a task with a faster rate has a higher priority than a task with a slower rate. In

addition, a task with the faster rate, preempts a task with a slower rate.
• Tasks run on a single processor.
• Time slicing, use of a defined time period during which a task can run in a preemptive

multitasking system, is not allowed.
• Processes do not crash and restart, especially during data transfers between tasks.
• Read and write operations on byte-sized variables are atomic.

Your execution framework communicates with external devices for reading and writing model input.
For example, model external devices by using Simulink S-Function blocks. Generate code for those
blocks with the rest of the algorithm.

Generate Code and Report

Open the Embedded Coder app. Then, generate code and a code generation report. The example
model generates a report.

Review Generated Code

From the code generation report, review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code
controls model code execution by calling the entry-point functions
rtwdemo_multirate_multitasking_step0 and
rtwdemo_multirate_multitasking_step1. Use this file as a starting point for coding your
execution framework.

• rtwdemo_multirate_multitasking.c contains entry points for the code that implements the
model algorithm. This file includes the rate scheduling code.

• rtwdemo_multirate_multitasking.h declares model data structures and a public interface to
the model entry points and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.
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Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework:

1 Include the generated header file by adding directive #include
rtwdemo_multirate_multitasking.h.

2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:

• rtU.In1_1s of data type real_T with dimension of 1
• rtU.In2_2s of data type real_T with dimension of 1

Entry-point functions:

• Initialization entry-point function, void
rtwdemo_multirate_multitasking_initialize(void). At startup, call this function once.

• Output and update entry-point (step) function, void
rtwdemo_multirate_multitasking_step0(void). Call this function periodically at the
fastest rate in the model. For this model, call the function every second. To achieve real-time
execution, attach this function to a timer.

• Output and update entry-point function, void
rtwdemo_multirate_multitasking_step1(void). Call this function periodically at the
second fastest rate in the model. For this model, call the function every two seconds. To achieve
real-time execution, attach this function to a timer.

Output ports:

• rtY.Out1 of data type real_T with dimension of 1
• rtY.Out2 of data type real_T with dimension of 1

More About

• “Modeling for Multitasking Execution”
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
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Model Concurrent Execution for Symmetric Multicore CPU
Platforms

Use Simulink® time-based, multitask scheduling to simulate and generate code for an application
algorithm captured in a single model hierarchy. The model is designed and configured for an
embedded system intended to execute on a symmetric multicore, multitasking platform.

Periodic Multirate Model Set Up for Multitasking Concurrent Execution

Open the example model rtwdemo_concurrent_execution. The model is configured to display color-
coded sample times with annotations. To see them, after opening the model, update the diagram by
pressing Ctrl+D. To display the legend, press Ctrl+J.

Simulink supports simulating concurrent task execution by assigning partitions of a model to tasks
that you designate to run concurrently on multicore hardware. Use an implicit or explicit approach to
designating partitions.

Simulink implicit partitioning:

• Partitions the model based on sample times specified in the model.
• Assigns a task to each sample rate and designates that the tasks run concurrently.
• Controls the granularity of partitions. For example, you cannot split a sample rate into multiple

tasks.
• Does not impose modeling constraints.
• Provides ready-to-use hardware solutions, such as solutions that the Simulink® Real-Time™

product produces.
• Is not relevant to standalone production code generation due to the lack of control over partition

granularity.

Explicit partitioning:

• Use Model and Subsystem blocks to partition the model.
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• Create an arbitrary number of tasks.
• Simulink assigns each partition to a task.
• Simulink imposes modeling constraints.
• Control the granularity of partitions.
• Split a sample rate into multiple tasks.
• Assign partitions to different processor cores.
• Is for standalone production code generation due to the level of control you have over granularity

of partitions.

This example shows explicit partitioning.

Consider the following periodic multirate model that is set up for multitasking execution.

• Sample times for Inport blocks In1_1s and In2_2s are set to 1 and 2 seconds, respectively.
• To provide a clear partitioning of rates, sample times for models SS1 and SS2 are set to 1.
• The Rate Transition block explicitly models a rate transition.

To support concurrent execution of tasks in a multicore run-time environment, the preceding model
was modified:

• The Integrator block is in a Model block configured with a fixed-step discrete solver and a step
size of two seconds.

• Subsystems SS1 and SS2 were converted to Model blocks configured with a fixed-step discrete
solver and a step size of one second.

• The Sum block is in a Model block configured with a fixed-step discrete solver and a step size of
one second. Another option for the Sum block is to place it in SS1 or SS2 and compute its value
coincident with the Model block. For concurrent execution of tasks, only connection blocks, Model
blocks, and Subsystem blocks can be at the root level of a model.

• The Rate Transition block was removed.

Relevant Model Configuration Parameter Settings

• Type set to Fixed-step.
• Solver set to discrete (no continuous states).
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• Treat each discrete rate as a separate task selected.
• Automatically handle rate transition for data transfer selected. Necessary because Rate

Transition block was removed.
• Allow tasks to execute concurrently on target selected.

Concurrent Execution Parameter Settings

Open the Concurrent Execution dialog box by clicking Configure Tasks on the Configuration
Parameters Solver pane. Selecting parameter Allow tasks to execute concurrently on target
enables the Configure Tasks button.

When selected, parameter Enable explicit model partitioning for concurrent behavior enables
concurrent execution options for the top-level model.

Click Tasks and Mapping to review the tasks and mapping.

Simulink creates a default mapping for each partition (Model block) by assigning each partition to a
separate task. Simulink designates that each partition executes concurrently and simulates latency
effects that data communication between processor cores imposes. This dialog box displays a
mapping consisting of partitions spread across two independent periodic triggers: SS1, SS2, and Sum
mapped to periodic trigger 1 and Integrator mapped to periodic trigger 2.
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Scheduling

Simulink® simulates the model based on the model configuration. Code generated from the model
implements the same execution semantics. Simulink propagates and uses the Inport block sample
times to order block execution based on a multicore, multitasking execution platform.

For this model, the sample time legend shows an implicit rate grouping. Red represents the fastest
discrete rate. Green represents the second fastest discrete rate.

The generated code schedules subrates in the model. In this example, the rate for Inport block
In2_2s, the green rate, is a subrate. The generated code properly transfers data between the rates.

Benefits of implicit Simulink rate grouping:

• Simulink does not impose architectural constraints on the model. Create a model without
imposing software architecture constraints within it.

• Your execution framework does not require details about underlying function scheduling and data
transfers between rates. Therefore, model interface requirements are simplified. The execution
framework uses generated interface code to write input, call the model step function, and read
output.

• The code generator optimizes code across rates, based on multitasking execution semantics.

Simulink enforces data transfer constraints:

• Data transfers occur between a single read task and a single write task.
• Tasks run on a single processor.
• Processes do not stop or restart, especially during data transfers between tasks.
• Read and write operations on byte-sized variables are atomic.

Your execution framework can communicate with external devices for reading and writing model
input. For example, model external devices by using Simulink S-Function blocks. Generate code for
those blocks with the rest of the algorithm.

Generate Code and Report

Generate code and a code generation report. The example model generates a report.

Review Generated Code

From the code generation report, review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code
controls model code execution by indirectly calling entry-point functions
PeriodicTrigger1_OneSecond_step, PeriodicTrigger1_TwoSecond_step, and
PeriodicTrigger2_OneSecond_step with the function
rtwdemo_concurrent_execution_step. Use this file as a starting point for coding your
execution framework.

• rtwdemo_concurrent_execution.c contains entry points for the code that implements the
model algorithm. This file includes the rate and task scheduling code.

• rtwdemo_concurrent_execution.h declares model data structures and a public interface to
the model entry points and data structures.

• model_reference_types.h contains type definitions for timing bridges. These type definitions
are generated for a model reference target or a model containing Model blocks.
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• rtw_windows.h declares mutex and semaphore function prototypes that the generated code uses
for concurrent execution on Microsoft® Windows® platforms.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework:

1 Include the generated header file by adding directive #include
rtwdemo_concurrent_execution.h.

2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:

• In1_1s of data type real_T with dimension of 1
• In2_2s of data type real_T with dimension of 1

Entry-point functions:

• Initialization entry-point function, void
rtwdemo_concurrent_execution_initialize(void). At startup, call this function once.

• Output and update entry-point (step) function, void
PeriodicTrigger1_OneSecond_step(void). Call this function periodically for one of two
tasks that require scheduling at the fastest rate in the model. For this model, call the function
every second.

• Output and update entry-point function, void PeriodicTrigger1_TwoSecond_step(void).
Call this function periodically at the second fastest rate in the model. For this model, call the
function every two seconds.

• Output and update entry-point function, void PeriodicTrigger2_OneSecond_step(void).
Call this function periodically for the second task that requires scheduling at the fastest rate in
the model. For this model, call the function every second.

To achieve real-time execution, define a task or thread for each entry-point step function. Trigger
execution of each function based on a timer that has the same rate as the given function. The
operating system schedules the tasks across cores dynamically or based on your mapping of tasks to
cores.

Output ports:

• Out1_1s of data type real_T with dimension 1
• Out2_1s of data type real_T with dimension 1

More About

• “Multicore Processor Targets”
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
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Model Explicit Function Invocation with Atomic Subsystems
Deploy embedded system code from Simulink® models by partitioning a model into multiple atomic
subsystems that you build separately.

Atomic Subsystem Model

Open the example model rtwdemo_explicitinvocation_atomicsubsys. The model is configured to
display color-coded sample times with annotations. To see them, after opening the model, update the
diagram by pressing Ctrl+D. To display the legend, press Ctrl+J.

This model partitions an algorithm into two atomic subsystems: Rate1s and Rate2s. Subsystem
Rate1s is configured with a sample time of 1 second. Subsystem Rate2s is configured with a sample
time of 2 seconds.

Relevant Model Configuration Parameter Settings

• Type set to Fixed-step.
• Solver set to discrete (no continuous states).
• Treat each discrete rate as a separate task cleared.

Scheduling

Simulink® simulates the model based on the model configuration. Simulink propagates and uses the
Inport block sample times to order block execution based on a single-core, single-tasking execution
platform.

For this example, the sample time legend shows implicit rate grouping. Red represents the fastest
discrete rate. Green represents the second fastest discrete rate.

Based on rate-monotonic scheduling, your application code (execution framework) must transfer data
between subsystems Rate2s and Rate1s at a frequency of 2 seconds with the priority of 1 second.
That is, the generated function transfers data in the 1 second task every other time prior to executing
code for subsystem Rate1s.
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Your execution framework must schedule the generated function code and handle the data transfers
between them. This is an advantage for multirate models because the generated code does not
assume scheduling or data transfer semantics. However, the execution framework must handle data
transfers explicitly.

Generate Code and Report

Generate a single callable function for each subsystem without connections between them. Multiple
ways are available to generate code for a subsystem, including from the subsystem context menu.

1 Open the Embedded Coder app.
2 Right-click a subsystem block.
3 Click C/C++ Code > Build This Subsystem.
4 In the Build code for Subsystem dialog box, click Build.

The example model generates a report.

Review Generated Code

Review the generated code in the Code view or the code generation report.

• ert_main.c is an example main program (execution framework) for the subsystem. This code
controls model code execution by calling entry-point function Rate1s_step or Rate2s_step.
Use this file as a starting point for coding your execution framework.

• Rate1s.c and Rate2s.c contain entry points for the code that implements subsystem Rate1s
and Rate2s, respectively. This file includes the rate and task scheduling code.

• Rate1s.h and Rate2s.h declare model data structures and a public interface to subsystem entry
points and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework:

1 Include the generated header file by adding directive #include
rtwdemo_explicitinvocation_atomicsusys.h.

2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports, Rate1s:

• rtU.In1 of type real_T with dimension of 1
• rtU.In2 of type real_T with dimension of 1

Entry-point functions, Rate1s:

• Initialize entry-point function, void Rate1s_initialize(void). At startup, call this function
once.

• Output and update entry-point (step) function, void Rate1s_step(void). Call this function
periodically, every second.
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• Termination function, void Rate1s_terminate(void). Call this function once from your
shutdown code.

Output ports, Rate1s:

• rtY.Out1 of type real_T with dimension of 1
• rtY.Out2 of type real_T with dimension of 1

Input ports, Rate2s:

• rtU.In1 of type real_T with dimension of 1

Entry-point functions, Rate2s:

• Initialize entry-point function, void Rate2s_initialize(void). Call this function once at
startup.

• Output and update entry-point (step), void Rate2s_step(void). Call this function periodically,
every 2 seconds.

• Termination function, void Rate2s_terminate(void). Call this function once from your
shutdown code.

Output ports, Rate2s:

• rtY.Out1 of type real_T with dimension of 1

More About

• “Generate Modular Function Code for Nonvirtual Subsystems” on page 41-2
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
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Model Explicit Function Invocation with Function-Call
Subsystems

Deploy embedded system code from Simulink® models by partitioning a model into function-call
subsystems that you build separately.

Function-Call Subsystem Model

Open the example model rtwdemo_explicitinvocation_funccallsubsys. The model is configured to
display color-coded sample times with annotations. To see them, after opening the model, update the
diagram by pressing Ctrl+D. To display the legend, press Ctrl+J.

This model partitions an algorithm into three function-call subsystems: Rate1s, Rate2s, and
DataBuffer. Use function-call subsystems to model multirate systems explicitly.

Subsystems Rate1s and DataBuffer use a sample time of 1 second. Subsystem Rate2s uses a
sample time of 2 seconds.

This model design is referred to as export function modeling. Simulink constrains the model to
function-call subsystems at the root level. The driving Inport block specifies the function name.

Relevant Model Configuration Parameter Settings

• Type set to Fixed-step.
• Solver set to discrete (no continuous states).
• Treat each discrete rate as a separate task selected. Simulink applies multitasking execution

because the model uses multiple sample rates.
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Scheduling

Simulink® simulates the model based on the model configuration. Simulink propagates and uses the
Inport block sample times to order block execution based on a single-core, multitasking execution
platform.

In the sample time legend, red identifies the fastest discrete rate. Magenta identifies rates inherited
from exported functions, indicating their execution is outside the context of Simulink scheduling.

Your execution framework must schedule the generated function code and transfer data between
functions.

Your execution framework needs to schedule the generated function code and handle data transfers
between functions. The generated code is simple and you control the order of execution.

Generate Code and Report

Open the Embedded Coder app. Then, generate code and a code generation report.

Review Generated Code

From the code generation report, review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code shows
how to call the exported functions. The code also shows how to initialize, execute, and terminate
the generated code.

• rtwdemo_explicitinvocation_funccallsubsys.c calls the initialization function and
exported functions for subsystems Rate1s, Rate2s, and DataBuffer.

• rtwdemo_explicitinvocation_funccallsubsys.h declares model data structures and a
public interface to the exported entry point functions and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework:

1 Include the generated header files by adding directives #include Rate1s.h, #include
DataBuffer.h, and #include Rate2s.h.

2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:

• rtU.In1_1s of type real_T with dimension of 1
• rtU.In2_2s of type real_T with dimension of 1

Entry-point functions:

• Initialize entry-point function, void
rtwdemo_explicitinvocation_funccallsubsys_initialize(void). At startup, call this
function once.
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• Exported function, void CallEvery1s(void). Call this function as needed.
• Exported function, void CallEvery1s(void). Call this function as needed.
• Exported function, void CallEvery2sAt1sPriority(void). Call this function as needed.

Output ports:

• rtY.Out1 of type real_T with dimension of 1
• rtY.Out2 of type real_T with dimension of 1

More About

• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
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Modeling in Simulink Coder

• “Blocks and Products Supported for Code Generation” on page 2-2
• “Modeling Semantic Considerations” on page 2-21
• “Modeling Guidelines for Blocks” on page 2-27
• “Modeling Guidelines for Subsystems” on page 2-28
• “Modeling Guidelines for Charts” on page 2-29
• “Modeling Guidelines for MATLAB Functions” on page 2-30
• “Modeling Guidelines for Model Configuration” on page 2-31
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Blocks and Products Supported for Code Generation
In this section...
“Related Products” on page 2-2
“Simulink Built-In Blocks That Support Code Generation” on page 2-4
“Simulink Block Data Type Support Table” on page 2-20
“Block Set Support for Code Generation” on page 2-20

As you construct a model, to prevent issues later in the development process, determine whether the
Simulink Coder and Embedded Coder code generators support the products and blocks that you want
to use.

Related Products
The following table summarizes MathWorks products that extend and complement Simulink Coder
software. For information about these products and how code generation supports them, refer to
their product documentation at www.mathworks.com.

Product Extends Code Generation Capabilities for ...
Aerospace Blockset™ Aircraft, spacecraft, rocket, propulsion systems, and

unmanned airborne vehicles
Audio Toolbox™ Audio processing systems
Automated Driving Toolbox™ Designing, simulating, and testing ADAS and

autonomous driving systems
AUTOSAR Blockset Modeling and simulation of AUTOSAR Classic and

Adaptive ECU software
Communications Toolbox™ Physical layer of communication systems
Computer Vision Toolbox™ Video processing, image processing, and computer

vision systems
Control System Toolbox™ Linear control systems
DSP System Toolbox™ Signal processing systems
Embedded Coder Embedded systems, rapid prototyping boards, and

microprocessors in mass production
Fixed-Point Designer™ Fixed-point systems
Fuzzy Logic Toolbox™ System designs based on fuzzy logic
HDL Verifier™ Direct programming interface (DPI) component and

transaction-level model (TLM) generation from
Simulink

IEC Certification Kit ISO 26262 and IEC 61508 certification
Model-Based Calibration Toolbox™ Developing processes for systematically identifying

optimal balance of engine performance, emissions, and
fuel economy, and reusing statistical models for control
design, hardware-in-the-loop (HIL) testing, or
powertrain simulation
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Product Extends Code Generation Capabilities for ...
Model Predictive Control Toolbox™ Model predictive controllers
Deep Learning Toolbox™ Neural networks
Parallel Computing Toolbox™ Parallel builds for large Simulink models
Phased Array System Toolbox™ Sensor array systems in radar, sonar, wireless

communications, and medical imaging applications
Polyspace® Bug Finder™ MISRA-C compliance and static analysis of generated

code
Polyspace Code Prover™ Formal analysis of generated code
Powertrain Blockset™ Real-time testing of powertrain applications
Robotics System Toolbox™ Design, simulate, and test robotics applications
ROS Toolbox Design, simulate, and deploy ROS-based applications
Simscape™ Systems spanning mechanical, electrical, hydraulic,

and other physical domains as physical networks
Simscape Driveline™ Driveline (drivetrain) systems
Simscape Electrical™ Electronic, electromechanical, and electrical power

systems
Simscape Fluids™ Hydraulic power and control systems
Simscape Multibody™ Three-dimensional mechanical systems
Simulink 3D Animation™ Systems with 3D visualizations
Simulink Check™ Model standards compliance checking and metrics
Simulink Code Inspector™ Automated reviews of generated code
Simulink Control Design™ Autotuning of PID controllers and online frequency

response estimation
Simulink Coverage™ Model and code structural coverage analysis
Simulink Design Optimization™ Tuning adaptive lookup tables and checking signal

characteristics
Simulink Desktop Real-Time™ Rapid prototyping or hardware-in-the-loop (HIL)

simulation of control system and signal processing
algorithms

Simulink Real-Time™ Rapid control prototyping, hardware-in-the-loop (HIL)
simulation, and other real-time testing applications

Simulink Report Generator™ Automatically generating project documentation in a
standard format

Simulink Requirements™ Authoring and tracing requirements to design and
code

Simulink Test™ Software-in-the-loop (SIL), processor-in-the-loop (PIL),
and real-time hardware-in-the-loop (HIL) testing of
generated code

SoC Blockset™ Designing, evaluating, and implementing SoC
hardware and software architectures
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Product Extends Code Generation Capabilities for ...
Stateflow® State machines and flow charts
System Identification Toolbox™ Systems identified from measured input-output data
Vehicle Dynamics Blockset™ Modeling and simulation of vehicle dynamics in 3D

environment
Vehicle Network Toolbox™ CAN blocks for Accelerator and Rapid Accelerator

simulations and code deployment on Windows®

Simulink Built-In Blocks That Support Code Generation
The following tables summarize code generator support for Simulink blocks. There is a table for each
block library. For more detail, including data types each block supports, in the MATLAB Command
Window, type showblockdatatypetable, or consult the block reference pages. For some blocks,
the generated code might rely on memcpy or memset (string.h).

• Additional Math and Discrete: Additional Discrete
• Additional Math and Discrete: Increment/Decrement
• Continuous
• Discontinuities
• Discrete
• Logic and Bit Operations
• Lookup Tables
• Math Operations
• Model Verification
• Model-Wide Utilities
• Ports & Subsystems
• Signal Attributes
• Signal Routing
• Sinks
• Sources
• User-Defined

Additional Math and Discrete: Additional Discrete

Block Support Notes
Fixed-Point State-Space The code generator does not explicitly group primitive

blocks that constitute a nonatomic masked subsystem
block in the generated code. This flexibility allows for
more efficient code generation. In certain cases, you can
achieve grouping by configuring the masked subsystem
block to execute as an atomic unit by selecting block
parameter Treat as atomic unit.

Transfer Fcn Direct Form II
Transfer Fcn Direct Form II Time Varying
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Additional Math and Discrete: Increment/Decrement

Block Support Notes
Decrement Real World The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Decrement Stored Integer

Decrement Time To Zero Supports code generation.
Decrement To Zero The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Increment Real World
Increment Stored Integer

Continuous

Block Support Notes
Derivative Not recommended for production-quality code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems. The
code generated can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.

In general, consider using the Simulink Model Discretizer to map continuous
blocks into discrete equivalents that support production code generation. Use
the Model Discretizer app. One exception is the Second-Order Integrator
block because, for this block, the Model Discretizer produces an approximate
discretization.

Integrator
Integrator, Integrator Limited
PID Controller
PID Controller (2DOF)
Second-Order Integrator,
Second-Order Integrator
Limited
State-Space
Transfer Fcn
Transport Delay
Variable Time Delay, Variable
Transport Delay
Zero-Pole
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Discontinuities

Block Support Notes
Backlash Supports code generation.
Coulomb and Viscous Friction The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Dead Zone Supports code generation.
Dead Zone Dynamic The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Hit Crossing Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Quantizer Supports code generation.
Rate Limiter Cannot use inside a triggered subsystem hierarchy.
Rate Limiter Dynamic The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Relay Support code generation.
Saturation
Saturation Dynamic The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Wrap To Zero

2 Modeling in Simulink Coder

2-6



Discrete

Block Support Notes
Delay Supports code generation.
Difference • The code generator does not explicitly group primitive blocks that

constitute a nonatomic masked subsystem block in the generated code.
This flexibility allows for more efficient code generation. In certain cases,
you can achieve grouping by configuring the masked subsystem block to
execute as an atomic unit by selecting block parameter Treat as atomic
unit.

• Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution
times. While the code is functionally valid and generally acceptable in
resource-rich environments, smaller embedded targets often cannot
support such code. Usually, blocks evolve toward being suitable for
production code. Thus, blocks suitable for production code remain
suitable.

Discrete Derivative • Depends on absolute time when used inside a triggered subsystem
hierarchy.

• Supports code generation.
Discrete Filter Support code generation.
Discrete FIR Filter
Discrete PID Controller • Depends on absolute time when used inside a triggered subsystem

hierarchy.
• Support code generation.

Discrete PID Controller (2DOF)

Discrete State-Space Support code generation.
Discrete Transfer Fcn
Discrete Zero-Pole
Discrete-Time Integrator Depends on absolute time when used inside a triggered subsystem hierarchy.
Enabled Delay Supports code generation.
First Order Hold Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Memory Support code generation.
Resettable Delay
Tapped Delay
Transfer Fcn First Order The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
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Block Support Notes
Transfer Fcn Lead or Lag allows for more efficient code generation. In certain cases, you can achieve

grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.Transfer Fcn Real Zero

Unit Delay Support code generation.
Variable Integer Delay
Zero-Order Hold

Logic and Bit Operations

Block Support Notes
Bit Clear Support code generation.
Bit Set
Bitwise Operator
Combinatorial Logic
Compare To Constant
Compare To Zero
Detect Change
Detect Decrease
Detect Fall Negative
Detect Fall Nonpositive
Detect Increase
Detect Rise Nonnegative
Detect Rise Positive
Extract Bits
Interval Test
Interval Test Dynamic
Logical Operator
Relational Operator
Shift Arithmetic
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Lookup Tables

Block Support Notes
Cosine The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting the Treat as atomic unit check box.

Direct Lookup Table (n-D) Support code generation.
Interpolation Using Prelookup
1-D Lookup Table
2-D Lookup Table
n-D Lookup Table
Lookup Table Dynamic
Prelookup
Sine The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.
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Math Operations

Block Support Notes
Abs Support code generation.
Add
Algebraic Constraint Ignored during code generation.
Assignment Support code generation.
Bias
Complex to Magnitude-Angle
Complex to Real-Imag
Divide
Dot Product
Find Nonzero Elements
Gain
Magnitude-Angle to Complex
Math Function (10^u)
Math Function (conj)
Math Function (exp)
Math Function (hermitian)
Math Function (hypot)
Math Function (log)
Math Function (log10)
Math Function (magnitude^2)
Math Function (mod)
Math Function (pow)
Math Function (reciprocal)
Math Function (rem)
Math Function (square)
Math Function (transpose)
Vector Concatenate, Matrix
Concatenate
MinMax
MinMax Running Resettable
Permute Dimensions
Polynomial
Product
Product of Elements
Real-Imag to Complex
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Block Support Notes
Sqrt, Signed Sqrt, Reciprocal
Sqrt
Reshape
Rounding Function
Sign
Sqrt, Signed Sqrt, Reciprocal
Sqrt
Sine Wave Function • Does not refer to absolute time when configured for sample-based

operation. Depends on absolute time when in time-based operation.
• Depends on absolute time when used inside a triggered subsystem

hierarchy.
Slider Gain Support code generation.
Sqrt
Squeeze
Subtract
Sum
Sum of Elements
Trigonometric Function Functions asinh, acosh, and atanh are not supported by all compilers. If

you use a compiler that does not support those functions, the software issues
a warning for the block and the generated code fails to link.

Unary Minus Support code generation.modeling Gui
Vector Concatenate, Matrix
Concatenate
Weighted Sample Time Math
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Model Verification

Block Support Notes
Assertion Supports code generation.
Check Discrete Gradient Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Check Dynamic Gap Support code generation.
Check Dynamic Lower Bound
Check Dynamic Range
Check Dynamic Upper Bound
Check Input Resolution Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Check Static Gap
Check Static Lower Bound
Check Static Range
Check Static Upper Bound

Model-Wide Utilities

Block Support Notes
Block Support Table Ignored during code generation.
DocBlock Uses the template symbol you specify for the Embedded Coder Flag block

parameter to add comments to generated code. Requires an Embedded
Coder license. For more information, see “Use a Simulink DocBlock to Add a
Comment” on page 53-5.

Model Info Ignored during code generation.
Timed-Based Linearization
Trigger-Based Linearization
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Ports & Subsystems

Block Support Notes
Subsystem, Atomic Subsystem,
Nonvirtual Subsystem,
CodeReuse Subsystem

Support code generation.

Configurable Subsystem
Enable
Enabled Subsystem
Enabled and Triggered
Subsystem
For Each Subsystem
For Iterator Subsystem
Function-Call Feedback Latch
Function-Call Generator
Function-Call Split
Function-Call Subsystem
If
If Action Subsystem
Inport (In1)
Model
Outport (Out1)
Resettable Subsystem
Subsystem
Switch Case
Switch Case Action Subsystem
Trigger
Triggered Subsystem
Unit System Configuration
Variant Subsystem
While Iterator Subsystem
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Signal Attributes

Block Support Notes
Bus to Vector Support code generation.
Data Type Conversion
Data Type Conversion Inherited
Data Type Duplicate
Data Type Propagation
Data Type Scaling Strip
IC Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Probe Supports code generation.
Rate Transition • Supports code generation.

• Cannot use inside a triggered subsystem hierarchy.
Signal Conversion Support code generation.
Signal Specification
Unit Conversion
Weighted Sample Time
Width
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Signal Routing

Block Support Notes
Bus Assignment Support code generation.
Bus Creator
Bus Selector
Data Store Memory
Data Store Read
Data Store Write
Demux
Environment Controller Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

From Support code generation.
Goto
Goto Tag Visibility
Index Vector
Manual Switch Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Manual Variant Sink Support code generation.
Manual Variant Source
Merge When multiple signals connected to a Merge block have a non-Auto storage

class, all non-Auto signals connected to that block must be identically
labeled and have the same storage class. When Merge blocks connect
directly to one another, these rules apply to all signals connected to Merge
blocks in the group.

Multiport Switch Support code generation.
Mux
Selector
State Reader
State Writer
Switch
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Block Support Notes
Variant Sink
Variant Source
Vector Concatenate

Sinks

Block Support Notes
Display Ignored for code generation.
Floating Scope and Scope
Viewer
Outport (Out1) Supports code generation.
Scope Ignored for code generation.
Stop Simulation • Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution
times. While the code is functionally valid and generally acceptable in
resource-rich environments, smaller embedded targets often cannot
support such code. Usually, blocks evolve toward being suitable for
production code. Thus, blocks suitable for production code remain
suitable.

• Generated code stops executing when the stop condition is true.
Terminator Supports code generation.
To File Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

To Workspace Ignored for code generation.
XY Graph
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Sources

Block Support Notes
Band-Limited White Noise Cannot use inside a triggered subsystem hierarchy.
Chirp Signal Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Clock

Constant Supports code generation.
Counter Free-Running Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Counter Limited • The code generator does not explicitly group primitive blocks that
constitute a nonatomic masked subsystem block in the generated code.
This flexibility allows for more efficient code generation. In certain cases,
you can achieve grouping by configuring the masked subsystem block to
execute as an atomic unit by selecting block parameter Treat as atomic
unit.

• Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution
times. While the code is functionally valid and generally acceptable in
resource-rich environments, smaller embedded targets often cannot
support such code. Usually, blocks evolve toward being suitable for
production code. Thus, blocks suitable for production code remain
suitable.

Digital Clock Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Enumerated Constant Supports code generation.
From File Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
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Block Support Notes
From Spreadsheet While the code is functionally valid and generally acceptable in resource-rich

environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

From Workspace Ignored for code generation.
Ground Support code generation.
Inport (In1)
Pulse Generator Cannot use inside a triggered subsystem hierarchy. Does not refer to

absolute time when configured for sample-based operation. Depends on
absolute time when in time-based operation.

Ramp Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Random Number Supports code generation.
Repeating Sequence • Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution
times. While the code is functionally valid and generally acceptable in
resource-rich environments, smaller embedded targets often cannot
support such code. Usually, blocks evolve toward being suitable for
production code. Thus, blocks suitable for production code remain
suitable.

• Consider using the Repeating Sequence Stair or Repeating Sequence
Interpolated block instead.

Repeating Sequence
Interpolated

• The code generator does not explicitly group primitive blocks that
constitute a nonatomic masked subsystem block in the generated code.
This flexibility allows for more efficient code generation. In certain cases,
you can achieve grouping by configuring the masked subsystem block to
execute as an atomic unit by selecting block parameter Treat as atomic
unit.

• Cannot use inside a triggered subsystem hierarchy.
Repeating Sequence Stair The code generator does not explicitly group primitive blocks that constitute

a nonatomic masked subsystem block in the generated code. This flexibility
allows for more efficient code generation. In certain cases, you can achieve
grouping by configuring the masked subsystem block to execute as an atomic
unit by selecting block parameter Treat as atomic unit.

Signal Builder Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
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Block Support Notes
Signal Generator While the code is functionally valid and generally acceptable in resource-rich

environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Sine Wave • Depends on absolute time when used inside a triggered subsystem
hierarchy.

• Does not refer to absolute time when configured for sample-based
operation. Depends on absolute time when in time-based operation.

Step Not recommended for production code. Relates to resource limits and
restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

Uniform Random Number Supports code generation.
Waveform Generator Not recommended for production code. Relates to resource limits and

restrictions on speed and memory often found in embedded systems.
Generated code can contain dynamic allocation and freeing of memory,
recursion, additional memory overhead, and widely-varying execution times.
While the code is functionally valid and generally acceptable in resource-rich
environments, smaller embedded targets often cannot support such code.
Usually, blocks evolve toward being suitable for production code. Thus,
blocks suitable for production code remain suitable.

User-Defined

Block Support Notes
Function Caller Support code generation.
Initialize Function
Interpreted MATLAB Function Consider using the MATLAB Function block instead.
Level-2 MATLAB S-Function If a corresponding TLC file is available, the Level-2 MATLAB S-Function

block uses the TLC file to generate code, otherwise code generation throws
an error.

MATLAB Function Support code generation.
MATLAB System
S-Function S-functions that call into MATLAB are not supported for code generation.
S-Function Builder
Simulink Function Support code generation.
Terminate Function
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Simulink Block Data Type Support Table
The Simulink Block Data Type Support table summarizes characteristics of blocks in the Simulink and
Fixed-Point Designer block libraries, including whether or not they are recommended for use in
production code generation. To view this table, in the MATLAB Command Window, type
showblockdatatypetable, or consult the block reference pages.

Block Set Support for Code Generation
Several products that include blocks are available for you to consider for code generation. However,
before using the blocks for one of these products, consult the documentation for that product to
confirm which blocks support code generation.
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Modeling Semantic Considerations
In this section...
“Data Propagation” on page 2-21
“Sample Time Propagation” on page 2-22
“Latches for Subsystem Blocks” on page 2-23
“Block Execution Order” on page 2-24
“Algebraic Loops” on page 2-25

Data Propagation
The first stage of code generation is compilation of the block diagram. This stage is analogous to that
of a C or C++ program. The compiler carries out type checking and preprocessing. Similarly, the
Simulink engine verifies that input/output data types of block ports are consistent, line widths
between blocks are of expected thickness, and the sample times of connecting blocks are consistent.

The Simulink engine propagates data from one block to the next along signal lines. The data
propagated consists of

• Data type
• Line widths
• Sample times

You can verify what data types a Simulink block supports by typing

showblockdatatypetable

at the MATLAB prompt, or (from the Help browser) clicking the command above.

The Simulink engine typically derives signal attributes from a source block. For example, the Inport
block's parameters dialog box specifies the signal attributes for the block.
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In this example, the Inport block has a port width of 3, a sample time of .01 seconds, the data type is
double, and the signal is complex.

This figure shows the propagation of the signal attributes associated with the Inport block through a
simple block diagram.

In this example, the Gain and Outport blocks inherit the attributes specified for the Inport block.

Sample Time Propagation
Inherited sample times in source blocks (for example, a root inport) can sometimes lead to
unexpected and unintended sample time assignments. Since a block may specify an inherited sample
time, information available at the outset is often insufficient to compile a block diagram completely.

In such cases, the Simulink engine propagates the known or assigned sample times to those blocks
that have inherited sample times but that have not yet been assigned a sample time. Thus, the engine
continues to fill in the blanks (the unknown sample times) until sample times have been assigned to
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as many blocks as possible. Blocks that still do not have a sample time are assigned a default sample
time.

For a completely deterministic model (one where no sample times are set using the above rules), you
should explicitly specify the sample times of your source blocks. Source blocks include root inport
blocks and blocks without input ports. You do not have to set subsystem input port sample times. You
might want to do so, however, when creating modular systems.

An unconnected input implicitly connects to ground. For ground blocks and ground connections, the
sample time is always constant (inf).

All blocks have an inherited sample time (Ts = -1). They are assigned a sample time of (Tf - Ti)/50.

Blocks Whose Outputs Have Constant Values

When you display sample time colors, by default, Constant blocks appear magenta in color to indicate
that the block outputs have constant values during simulation. Downstream blocks whose output
values are also constant during simulation, such as Gain blocks, similarly appear magenta if they use
an inherited sample time. The code generated for these blocks depends in part on the tunability of
the block parameters.

If you set model configuration parameter Default parameter behavior to Inlined, the block
parameters are not tunable in the generated code. Because the block outputs are constant, the code
generator eliminates the block code due to constant folding. If the code generator cannot fold the
code, or if you select settings to disable constant folding, the block code appears in the model
initialization function. The generated code is more efficient because it does not compute the outputs
of these blocks during execution.

However, if you configure a block or model so that the block parameters appear in the generated
code as tunable variables, the code generator represents the blocks in a different way. Block
parameters are tunable if, for example:

• You set parameter Default parameter behavior to Tunable. By default, numeric block
parameters appear as tunable fields of a global parameter structure.

• You use a tunable parameter, such as a Simulink.Parameter object that uses a storage class
other than Auto, as the value of one or more numeric block parameters. These block parameters
are tunable regardless of the setting that you choose for model configuration parameter Default
parameter behavior.

If a block parameter is tunable, the generated code must compute the block outputs during
execution. Therefore, the block code appears in the model step function. If the model uses multiple
discrete rates, the block code appears in the output function for the fastest downstream rate that
uses the block outputs.

Latches for Subsystem Blocks
When an Inport block is the signal source for a triggered or function-call subsystem, you can use
latch options to preserve input values while the subsystem executes. The Inport block latch options
include:

For Use
Triggered subsystems Latch input by delaying outside signal
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For Use
Function-call subsystems Latch input for feedback signals of function-call subsystem outputs

When you select subsystem block parameter Latch input for feedback signals of function-call
subsystem outputs for a function-call subsystem, the code generator

• Preserves latches in generated code regardless of optimizations that might be set
• Places the code for latches at the start of a subsystem's output/update function

For more information on these options, see the block description of Inport.

Block Execution Order
Once the Simulink engine compiles the block diagram, it creates a model.rtw file (analogous to an
object file generated from a C or C++ file). The model.rtw file contains the connection information
of the model, as well as the signal attributes. Thus, the timing engine in can determine when blocks
with different rates should be executed.

You cannot override this execution order by directly calling a block (in handwritten code) in a model.
For example, in the next figure the disconnected_trigger model on the left has its trigger port
connected to ground, which can lead to the blocks inheriting a constant sample time. Calling the
trigger function, f(), directly from user code does not work. Instead, you should use a function-call
generator to specify the rate at which f() should be executed, as shown in the connected_trigger
model on the right.

Instead of the function-call generator, you could use another block that can drive the trigger port.
Then, you should call the model's main entry point to execute the trigger function.

For multirate models, a common use of the code generator is to generate code for individual models
separately and then manually code the I/O between the generated code modules. This approach
places the burden of data consistency between models on the developer of the models. Another
approach is to let Simulink and the code generator maintain data consistency between rates and
generate multirate code for use in a multitasking environment. The Rate Transition block is able to
interface periodic and asynchronous signals. For a description of the Simulink Coder block libraries,
see “Asynchronous Events”. For more information on multirate code generation, see “Modeling for
Multitasking Execution”.
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Algebraic Loops
Algebraic loops are circular dependencies between variables. This prevents the straightforward
direct computation of their values. For example, in the case of a system of equations

• x = y + 2
• y = -x

the values of x and y cannot be directly computed.

To solve this, either repeatedly try potential solutions for x and y (in an intelligent manner, for
example, using gradient based search) or “solve” the system of equations. In the previous example,
solving the system into an explicit form leads to

• 2x = 2
• y = -x
• x = 1
• y = -1

An algebraic loop exists whenever the output of a block having direct feedthrough (such as Gain,
Sum, Product, and Transfer Fcn) is fed back as an input to the same block. The Simulink engine is
often able to solve models that contain algebraic loops, such as the next diagram.

The code generator does not produce code that solves algebraic loops. This restriction includes
models that use Algebraic Constraint blocks in feedback paths. However, the Simulink engine can
often eliminate algebraic loops that arise, by grouping equations in certain ways in models that
contain them. It does this by separating the update and output functions to avoid circular
dependencies. For details, see “Algebraic Loop Concepts”.

Algebraic Loops in Triggered Subsystems

While the Simulink engine can minimize algebraic loops involving atomic and enabled subsystems, a
special consideration applies to some triggered subsystems. An example for which code can be
generated is shown in the following model and triggered subsystem.
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The default Simulink behavior is to combine output and update methods for the subsystem, which
creates an apparent algebraic loop, even though the Unit Delay block in the subsystem has no direct
feedthrough.

You can allow the Simulink engine to solve the problem by splitting the output and update methods of
triggered and enabled-triggered subsystems when feasible. If you want the code generator to take
advantage of this feature, select subsystem block parameter Minimize algebraic loop
occurrences. Select this parameter to avoid algebraic loop warnings in triggered subsystems
involved in loops.

Note If you check this box, the generated code for the subsystem might contain split output and
update methods, even if the subsystem is not actually involved in a loop. Also, if a direct feedthrough
block (such as a Gain block) is connected to the inport in the above triggered subsystem, the Simulink
engine cannot solve the problem, and the code generator is unable to generate code.

A model configuration parameter Minimize algebraic loop occurrences is available also. Selecting
it enables the code generator to produce code for models containing Model blocks that are involved
in algebraic loops.
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Modeling Guidelines for Blocks
Code generation modeling guidelines include recommended model settings, block usage, and block
parameters. When you develop models for code generation, use these guidelines.

Code Generation
Modeling
Guidelines

“cgsl_0101: Zero-based indexing”

“cgsl_0102: Evenly spaced breakpoints in lookup tables”

“cgsl_0103: Precalculated signals and parameters”

“cgsl_0104: Modeling global shared memory using data stores”

“cgsl_0105: Modeling local shared memory using data stores”

“cgsl_0201: Redundant Unit Delay and Memory blocks”

For more information, see “Model Advisor Checks for High-Integrity Modeling Guidelines” and
“Model Advisor Checks for MAB and JMAAB Compliance” (Simulink Check).

See Also
“Modeling Guidelines for Subsystems” on page 2-28 | “Modeling Guidelines for Charts” on page 2-
29 | “Modeling Guidelines for MATLAB Functions” on page 2-30 | “Modeling Guidelines for Model
Configuration” on page 2-31
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Modeling Guidelines for Subsystems
When you develop models and generate code for subsystems, use the modeling guideline
recommendations.

Code Generation
Modeling
Guidelines

“cgsl_0204: Vector and bus signals crossing into atomic subsystems or Model
blocks”

High-Integrity
Systems Modeling
Guidelines

hisl_0007: Usage of For Iterator or While Iterator subsystems

“hisl_0010: Usage of If blocks and If Action Subsystem blocks”

“hisl_0011: Usage of Switch Case blocks and Action Subsystem blocks”

“hisl_0023: Verification of variant blocks”
MathWorks
Advisory Board
(MAB) Control
Algorithm
Guidelines

db_0042: Usage of Inport and Outport blocks

db_0081: Unconnected signals and blocks

db_0143: Usable block types in model hierarchy

db_0144: Use of subsystems

db_0146: Block layout in conditional subsystems

jc_0201: Usable characters for subsystem names

jc_0231: Usable characters for block names

jc_0281: Trigger signal names

jm_0002: Block resizing

na_0008: Display of labels on signals

na_0009: Entry versus propagation of signal labels

For more information, see “Model Advisor Checks for High-Integrity Modeling Guidelines” and
“Model Advisor Checks for MAB and JMAAB Compliance” (Simulink Check).

See Also
“Modeling Guidelines for Blocks” on page 2-27 | “Modeling Guidelines for Charts” on page 2-29 |
“Modeling Guidelines for MATLAB Functions” on page 2-30 | “Modeling Guidelines for Model
Configuration” on page 2-31
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Modeling Guidelines for Charts
When you develop models and generate code for charts, use the modeling guideline
recommendations.

High-Integrity
Systems Modeling
Guidelines

“hisf_0001: State Machine Type”

“hisf_0002: User-specified state/transition execution order”

“hisf_0009: Strong data typing (Simulink and Stateflow boundary)”

“hisf_0011: Stateflow debugging settings”

“hisf_0003: Usage of bitwise operations”

“hisf_0004: Protect against recursive function calls to improve code compliance”

“hisf_0007: Usage of junction conditions (maintaining mutual exclusion)”

“hisf_0013: Usage of transition paths (crossing parallel state boundaries)”

“hisf_0014: Usage of transition paths (passing through states)”

“hisf_0015: Strong data typing (casting variables and parameters in
expressions)”

MathWorks
Advisory Board
(MAB) Modeling
Guidelines

db_0127: Limitation on MATLAB commands in Stateflow blocks

jc_0451: Use of unary minus on unsigned integers

jc_0481: Use of hard equality comparisons for floating point numbers in
Stateflow

jc_0501: Format of entries in a State block

jc_0511: Return values from a graphical function

jc_0531: Default transition

jm_0011: Pointers in Stateflow

na_0001: Standard usage of Stateflow operators

For more information, see “Model Advisor Checks for High-Integrity Modeling Guidelines” and
“Model Advisor Checks for MAB and JMAAB Compliance” (Simulink Check).

See Also
“Modeling Guidelines for Blocks” on page 2-27 | “Modeling Guidelines for Subsystems” on page 2-28 |
“Modeling Guidelines for MATLAB Functions” on page 2-30 | “Modeling Guidelines for Model
Configuration” on page 2-31
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Modeling Guidelines for MATLAB Functions
When you develop models and generate code for MATLAB Functions, use the modeling guideline
recommendations.

High-Integrity
Systems Modeling
Guidelines

“himl_0001: Usage of standardized MATLAB function headers”

“himl_0002: Strong data typing at MATLAB function boundaries”

“himl_0003: Limitation of MATLAB function complexity”

For more information, see “Model Advisor Checks for High-Integrity Modeling Guidelines” and
“Model Advisor Checks for MAB and JMAAB Compliance” (Simulink Check).

See Also
“Modeling Guidelines for Blocks” on page 2-27 | “Modeling Guidelines for Subsystems” on page 2-28 |
“Modeling Guidelines for Charts” on page 2-29 | “Modeling Guidelines for Model Configuration” on
page 2-31
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Modeling Guidelines for Model Configuration
When you develop models and generate code, use the modeling guideline configuration
recommendations.

Code Generation
Modeling
Guidelines

“cgsl_0301: Prioritization of code generation objectives for code efficiency”

“cgsl_0302: Diagnostic settings for multirate and multitasking models”
High-Integrity
Systems Modeling
Guidelines

“hisl_0043: Configuration Parameters > Diagnostics > Solver”

“hisl_0044: Configuration Parameters > Diagnostics > Sample Time”

“hisl_0301: Configuration Parameters > Diagnostics > Compatibility”

“hisl_0302: Configuration Parameters > Diagnostics > Data Validity >
Parameters”

“hisl_0303: Configuration Parameters > Diagnostics > Data Validity > Merge
blocks”

“hisl_0304: Configuration Parameters > Diagnostics > Data Validity > Model
initialization”

“hisl_0305: Configuration Parameters > Diagnostics > Data Validity >
Debugging”

“hisl_0306: Configuration Parameters > Diagnostics > Connectivity > Signals”

“hisl_0307: Configuration Parameters > Diagnostics > Connectivity > Buses”

“hisl_0308: Configuration Parameters > Diagnostics > Connectivity > Function
calls”

“hisl_0309: Configuration Parameters > Diagnostics > Type Conversion”

“hisl_0310: Configuration Parameters > Diagnostics > Model Referencing”

“hisl_0311: Configuration Parameters > Diagnostics > Stateflow”

For more information, see “Model Advisor Checks for High-Integrity Modeling Guidelines” and
“Model Advisor Checks for MAB and JMAAB Compliance” (Simulink Check).

See Also
“Modeling Guidelines for Blocks” on page 2-27 | “Modeling Guidelines for Subsystems” on page 2-28 |
“Modeling Guidelines for Charts” on page 2-29 | “Modeling Guidelines for MATLAB Functions” on
page 2-30
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Subsystems in Simulink Coder

• “Control Generation of Functions for Subsystems” on page 3-2
• “Generate Code and Executables for Individual Subsystems” on page 3-5
• “Inline Subsystem Code” on page 3-8
• “Generate Subsystem Code as Separate Function and Files” on page 3-10
• “Optimize Code for Identical Nested Subsystems” on page 3-11
• “Code Generation of Constant Parameters” on page 3-12
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Control Generation of Functions for Subsystems

What is a Subsystem Function?
A subsystem function is a function that the code generator produces for a subsystem in a model. The
function interface and how the code generator packages the code depends on whether the subsystem
is a virtual or atomic (nonvirtual) subsystem and how you configure the subsystem block parameters.
For more information, see Subsystem, Atomic Subsystem, CodeReuse Subsystem.

Options for Controlling Generation of Subsystem Function Code
You can design and configure a model in a way that controls how the code generator produces code
from subsystems.

To See
Generate inlined code from a selected subsystem. “Inline Subsystem Code” on page 3-8
Generate code for only a subsystem. “Generate Code and Executables for Individual

Subsystems” on page 3-5
Generate separate functions without arguments,
and optionally place the subsystem code in a
separate file.

“Generate Subsystem Code as Separate Function
and Files” on page 3-10

Generate a single reentrant function for a
subsystem that is included in multiple places
within a model.

“Generate Reentrant Code from Subsystems” on
page 7-33

Generate a single reentrant function for a
subsystem that is included in multiple places in a
model reference hierarchy.

“Generate Reusable Code from Library
Subsystems Shared Across Models” on page 7-
41

Generate code for a reusable library subsystem
that contains multiple function interfaces.

“Library-Based Code Generation for Reusable
Library Subsystems” on page 8-2

Subsystem Function Dependence
Code generated from subsystems can be completely independent of code generated for a model.
When generating code for a subsystem, the code can reference global data structures of the model,
even if the subsystem function code is in a separate file. Each subsystem code file contains include
directives and comments describing the dependencies. The code generator checks for cyclic file
dependencies and warns about them at build time. For descriptions of how the code generator
packages code, see “Manage Build Process File Dependencies”.

To generate subsystem function code that is independent of the code generated for the parent model,
place the subsystem in a library and configure it as a reusable subsystem, as explained in “Generate
Reusable Code from Library Subsystems Shared Across Models” on page 7-41.

If you have an Embedded Coder license, you can generate code for library consisting of reusable
subsystems that have different function interfaces. For more information, see “Library-Based Code
Generation for Reusable Library Subsystems” on page 8-2.
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Preserve Subsystem Boundaries in Generated Code
This example shows how to preserve the boundary of a virtual subsystem. By selecting subsystem
parameter Treat as atomic unit, you instruct the code generator to build code for the subsystem so
that it executes as an atomic unit. Once you mark a system as atomic, you can specify how the code
generator represents the subsystem in code by setting the block parameter Code Generation
Function Packaging. You can specify that the code generator produce these code implementations
for the subsystem:

• Inline: Inline the subsystem code at the call sites
• Function: A void/void function with I/O and internal data in global data structure
• Reusable function: A re-entrant function with data passed in as part of function arguments
• Auto: Let Simulink Coder optimize the implementation based on context

1. Generate code and a code generation report.

2. Use the generated report to inspect the generated source file rtwdemo_atomic.c. For SS1, the
code generator produces reusable function code with function name myfun.

Simulink and Simulink Coder can avoid artificial algebraic loops if you select parameter Minimize
algebraic loop occurrences. See the Simulink documentation for information on minimizing
occurrences of algebraic loops.

Example Model

model = 'rtwdemo_atomic';
open_system(model);

 Control Generation of Functions for Subsystems

3-3



See Also

Related Examples
• “Modeling Guidelines for Subsystems” on page 2-28
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Generate Code and Executables for Individual Subsystems
You can generate code and build an executable for a subsystem within a model. The code generation
and build process uses the code generation and build parameters of the root model.

1 In the Configuration Parameters dialog box, set up the code generation and build parameters,
similar to setting up the code generation for a model.

2 Right-click the Subsystem block. From the context menu, select C/C++ Code > Build This
Subsystem from the context menu.

Alternatively, in the current model, click a subsystem and then from the C Code tab, click Build.

Note When you select Build This Subsystem, if the model is operating in external mode, the
build process automatically turns off external mode for the duration of the build. The code
generator restores external mode upon completion of the build process.

3 The Build code for Subsystem window displays a list of the subsystem parameters. The upper
pane displays the name, class, and storage class of each variable (or data object) that is
referenced as a block parameter in the subsystem. When you select a parameter in the upper
pane, the lower pane shows the blocks that reference the parameter and the parent system of
each block.

The Storage Class column contains a menu for each row. The menu options set the storage class
or inline the parameter. To declare a parameter to be tunable, set the Storage Class to a value
other than Inlined.

For more information on tunable and inlined parameters and storage classes, see “Create
Tunable Calibration Parameter in the Generated Code” on page 34-109.

4 After selecting tunable parameters, click Build to initiate the code generation and build process.

 Generate Code and Executables for Individual Subsystems

3-5



5 The build process displays status messages in the MATLAB Command Window. When the build is
complete, the generated executable is in your working folder. The name of the generated
executable is subsystem.exe (on PC platforms) or subsystem (on The Open Group UNIX®

platforms). subsystem is the name of the source subsystem block.

The generated code is in a build subfolder, named subsystem_target_rtw. subsystem is the
name of the source subsystem block and target is the name of the target configuration.

When you generate code for a subsystem, you can generate an S-function by right-clicking the
Subsystem block and selecting C/C++ Code > Build This Subsystem from the context menu. For
more information on S-functions, see “Generate S-Function from Subsystem”.

Subsystem Build Limitations
The following limitations apply to building subsystems:

• Subsystem build does not support a subsystem that has a function-call trigger input or a function-
call output.

• When you right-click a Subsystem block and select C/C++ Code > Build This Subsystem from
the context menu to build a subsystem that includes an Outport block for which the Data type
parameter specifies a bus object, you must address errors that result from setting signal labels. To
configure the software to display these errors, in the Configuration Parameters dialog box for the
parent model, on the Diagnostics > Connectivity pane, set the Signal label mismatch
parameter to error.

• When a subsystem is in a triggered or function-call subsystem, the right-click build process might
fail if the subsystem code is not sample-time independent. To find out whether a subsystem is
sample-time independent:

1 Copy all blocks in the subsystem to an empty model.
2 In the Configuration Parameters dialog box, on the Solver pane, set:

a Type to Fixed-step.
b Periodic sample time constraint to Ensure sample time independent.
c Click Apply.

3 Update the model. If the model is sample-time dependent, Simulink generates an error in the
process of updating the diagram.

• When you use the right-click build process for a subsystem, the code generator attempts to use
the subsystem name for generated code files. In some cases, there can be a conflict with the name
that you specify when you set, for example, File name options to Use function name or
Function name options to Use subsystem name. You see an error:

The subsystem 'model/subsys' 
is trying to generate code to an reserved file (subsys) for 
the model 'subsys'...

To resolve the error, modify one of the conflicting file names so that the names are unique.
• In a subsystem build warning, the subsystem block path hyperlink that is created references a

temporary model block path instead of the actual model block path. In the Diagnostic Viewer,
clicking the subsystem hyperlink does not take you to the block. In the Command Window, you see
a message:
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...
No system or file called 'subsystemName' found.
...
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Inline Subsystem Code
You can configure a nonvirtual subsystem to inline the subsystem code with the model code. In the
Subsystem Parameters dialog box, setting the Function packaging parameter to Auto or Inline
inlines the generated code of the subsystem.

The Auto option is the default. When there is only one instance of a subsystem in the model, the
Auto option inlines the subsystem code. When multiple instances of a subsystem exist, the Auto
option results in a single copy of the function (as a reusable function). For function-call subsystems
with multiple callers, the subsystem code is generated as if you specified Nonreusable function.

To inline subsystem code, select Inline. The Inline option explicitly directs the code generator to
inline the subsystem unconditionally.

Configure Subsystem to Inline Code
To configure your subsystem for inlining:

1 Right-click the Subsystem block. From the context menu, select Block Parameters
(Subsystem).

2 In the Subsystem Parameters dialog box, if the subsystem is virtual, select Treat as atomic unit.
This option makes the subsystem nonvirtual. On the Code Generation tab, the Function
packaging option is now available.

If the system is already nonvirtual, the Function packaging option is already selected.
3 Click the Code Generation tab and select Auto or Inline from the Function packaging

parameter.

4 Click Apply and close the dialog box.
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The border of the subsystem thickens, indicating that it is nonvirtual.

When you generate code from your model, the code generator inlines subsystem code within
model.c or model.cpp (or in its parent system's source file). You can identify this code by system/
block identification tags, such as:

/* Atomic SubSystem Block: <Root>/AtomicSubsys1 */

Exceptions to Inlining
There are certain cases in which the code generator does not inline a nonvirtual subsystem, even
though the Inline option is selected.

• If the subsystem is a function-call subsystem that is called by a noninlined S-function, the Inline
option is ignored. Noninlined S-functions make calls by using function pointers. Therefore, the
function-call subsystem must generate a function with all arguments present.

• In a feedback loop involving function-call subsystems, the code generator forces one of the
subsystems to be generated as a function instead of inlining it. Based on the order in which the
subsystems are sorted internally, the software selects the subsystem to be generated as a function.

• If a subsystem is called from an S-function block that sets the option
SS_OPTION_FORCE_NONINLINED_FCNCALL to TRUE, it is not inlined. When user-defined Async
Interrupt blocks or Task Sync blocks are present, this result might occur. Such blocks must be
generated as functions. These blocks are located in the vxlib1 block library and use the
SS_OPTION_FORCE_NONINLINED_FCNCALL option. This library demonstrates integration with an
example RTOS (VxWorks®).1

Note You can use the blocks in the vxlib1 library (Async Interrupt and Task Sync) for simulation
and code generation. These blocks provide starting point examples to help you develop custom blocks
for your target environment.

1. VxWorks is a registered trademark of Wind River® Systems, Inc.
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Generate Subsystem Code as Separate Function and Files
To generate a separate subsystem function and a separate file for a subsystem in a model:

1 Right-click a Subsystem block. From the context menu, select Block Parameters (Subsystem).
2 In the Subsystem Parameters dialog box, if the subsystem is virtual, select Treat as atomic unit.

On the Code Generation tab, the Function packaging parameter is now available.
3 Click the Code Generation tab and select Nonreusable function from the Function

packaging parameter. The Nonreusable function option enables two parameters:

• The Function name options parameter controls the naming of the generated function.
• The File name options parameter controls the naming of the generated file.

4 Set the Function name options parameter.
5 Set the File name options parameter to a value other than Auto. If you are generating a

reusable function for your subsystem, see “Generate Reentrant Code from Subsystems” on page
7-33 or “Generate Reusable Code from Library Subsystems Shared Across Models” on page 7-
41.

6 Click Apply and close the dialog box.
7 Open the Configuration Parameters dialog box. Set the model configuration parameter File

packaging format to Modular.
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Optimize Code for Identical Nested Subsystems
The Function packaging parameter Auto option can optimize code in situations in which identical
subsystems contain other identical subsystems, by both reusing and inlining generated code. Suppose
a model, such as the one shown in “Reuse of Identical Nested Subsystems” on page 3-11, contains
identical subsystems A1 and A2. A1 contains subsystem B1, and A2 contains subsystem B2, which are
identical. In such cases, the Auto option causes one function to be generated which is called for both
A1 and A2. This function contains one piece of inlined code to execute B1 and B2. This optimization
generates less code which improves execution speed.

Reuse of Identical Nested Subsystems
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Code Generation of Constant Parameters
The code generator attempts to generate constant parameters to the shared utilities folder first. If
constant parameters are not generated to the shared utilities folder, they are defined in the top model
in a global constant parameter structure. The declaration of the structure, ConstParam_model, is in
model.h:

/* Constant parameters (auto storage) */
typedef struct {
   /* Expression: [1 2 3 4 5 6 7]
    * Referenced by: '<Root>/Constant'
    */
   real_T Constant_Value[7];
   
   /* Expression: [7 6 5 4 3 2 1]
    * Referenced by: '<Root>/Gain'
    */
   real_T Gain_Gain[7];
 } ConstParam_model;

The definition of the constant parameters, model_constP, is in:

/* Constant parameters (auto storage) */
const ConstParam_model model_ConstP = {
   /* Expression: [1 2 3 4 5 6 7]
    * Referenced by: '<Root>/Constant'
    */
   { 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0 },

   /* Expression: [7 6 5 4 3 2 1]
    * Referenced by: '<Root>/Gain'
    */
   { 7.0, 6.0, 5.0, 4.0, 3.0, 2.0, 1.0 }
};

The model_constP is passed as an argument to referenced models.

See Also

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Generate Inlined Subsystem Code
You can configure a nonvirtual subsystem to inline the subsystem code with the model code. In the
Subsystem Parameters dialog box, the Function packaging parameter specifies the format of the
subsystem’s generated code. This parameter has four settings: Auto, Inline, Nonreusable
function, and Reusable function. The code generator can generate inlined code for the Auto or
Inline settings.

The Inline setting explicitly directs the code generator to inline the subsystem code unconditionally.

The default Auto setting directs the code generator to generate the most efficient code for the
subsystem based on the type and number of instances of the subsystem that exist in the model. When
there is only one instance of a subsystem, the Auto setting inlines the subsystem code. When there
are multiple instances of a subsystem, that is not too complex, the Auto setting inlines the code for
each subsystem. Otherwise, the Auto setting generates a single copy of the function (as a reusable
function). For a function-call subsystem with multiple callers, the Auto setting generates subsystem
code that is consistent with the Nonreusable function setting.

Configure Subsystem to Inline Code
To configure your subsystem for inlining:

1 Right-click the Subsystem block. From the context menu, select Block Parameters
(Subsystem).

2 In the Subsystem Parameters dialog box, if the subsystem is virtual, select Treat as atomic unit.
This option makes the subsystem nonvirtual. On the Code Generation tab, the Function
packaging option is now available.

3 Click the Code Generation tab and select Auto or Inline from the Function packaging
parameter.

4 Click Apply and close the dialog box.

The border of the subsystem thickens, indicating that it is nonvirtual.

When you generate code from your model, the code generator inlines subsystem code within
model.c or model.cpp (or in its parent system's source file). You can identify this code by system/
block identification tags, such as:

/* Atomic SubSystem Block: <Root>/AtomicSubsys1 */

Exceptions to Inlining
There are certain cases in which the code generator does not inline a nonvirtual subsystem, even
though you select the Inline setting.

• If a noninlined S-function calls a function-call subsystem, the code generator ignores the Inline
setting. Because noninlined S-functions use function pointers to make function calls, the code
generator must generate a function with all arguments present.

• In a feedback loop involving function-call subsystems, the code generator generates a function
instead of inlined code for one of the subsystems. Based on the internal, sorted order of the
subsystems, the code generator selects which subsystem to generate a function.
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• If an S-function, an Async Interrupt, or a Task Sync block with the option
SS_OPTION_FORCE_NONINLINED_FCNCALL set to TRUE calls a subsystem, the code generator
generates a function instead of inlined code for the subsystem. The VxWorks block library
(vxlib1), contains the user-defined Async Interrupt and Task Sync blocks.2

See Also
• “Control Generation of Functions for Subsystems”
• “Generate Subsystem Code as Separate Function and Files”
• “Generate Reentrant Code from Subsystems”

2. VxWorks is a registered trademark of Wind River Systems, Inc.
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Generate Predictable Function Interface to Match Graphical
Block Interface

You can generate code for nonreusable Subsystem that has a predictable function interface. A
predictable interface can be useful for debugging and testing your code and integrating it with
external applications. The generated code with a predicatable function interface is more readable.

When you specify block parameter Function interface as Allow arguments (Match graphical
interface), the generated function interface matches the Subsystem's graphical block interface.
For example, if a Subsystem has two Inports and one Outport, the function interface generates two
arguments for the Inports and one function argument for the Outport. The order of the arguments is
determined by the port index. The function interface is predictable and does not change.

When you generate code for nonreusable Subsystem with the block parameter Function interface
set to Allow arguments (Optimized), the code generator generates a Subsystem function
interface that passes data through arguments. The function arguments might not match with the
Subsystem's graphical block interface.

This example shows how the generated code is different when you specify Function interface as
Allow arguments (Optimized) and Allow arguments (Match graphical interface).

Generate Function Interface That Has Optimized Arguments

1. Open the example model ex_mux_allow_arguments. The Subsystem in the model contains three
inputs and two outputs.

2. Right-click the Subsystem and select Block Parameters (Subsystem) from the context menu.
Alternatively, click in the Subsystem to open the Block Parameters dialog box in the Property
Inspector pane.

3. Observe these preset settings that are needed to generate expected code:

• In the Main tab, the block parameter Treat as atomic unit is selected.

• In the Code Generation tab, Function packaging is Nonreusable function and Function
interface is Allow arguments (Optimized).
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4. Open the Embedded Coder app. Click Build.

The generated code in ex_mux_allow_arguments.c file contains a Subsystem function interface
with arguments:

/* Output and update for atomic system: '<Root>/Subsystem' */
static void FPCSS_Mux(real_T rtu_In1, real_T rtu_In2, real_T rty_Out2[4])
{
  /* Constant: '<S1>/Constant1' */
  rtDW.Constant1 = 5.0;

  /* Gain: '<S1>/Gain4' */
  rtDW.Gain4 = 10.0 * rtu_In1;

  /* Gain: '<S1>/Gain1' incorporates:
   *  Constant: '<S1>/Constant'
   */
  rty_Out2[0] = 150.0;
  rty_Out2[1] = 15.0 * rtu_In2;
  rty_Out2[2] = 15.0 * rtu_In1;
  rty_Out2[3] = 15.0 * rtu_In2;
}

The Allow arguments (Optimized) specification leads to optimized generated code by reducing
global RAM. The function interface has some inputs and outputs as function arguments. The
generated function interface does not match the Subsystem's graphical block interface.

Generate Function Interface That Has Arguments that Match Graphical Interface

1. In the example model ex_mux_allow_arguments, open the Subsystem Block Parameters dialog
box.

2. On the Code Generation tab, specify Function interface as Allow arguments (Match
graphical interface) and click Apply.

3. Generate code for the model.

The generated code in ex_mux_allow_arguments.c file contains a Subsystem function interface
with arguments that match the Subsystem block interface:

/* Output and update for atomic system: '<Root>/Subsystem' */
static void FPCSS_Mux(real_T rtu_In1, const real_T rtu_In2[2], real_T rtu_In3,
                      real_T rty_Out1[2], real_T rty_Out2[4])
{
  /* SignalConversion generated from: '<S1>/Out1' incorporates:
   *  Constant: '<S1>/Constant1'
   *  Gain: '<S1>/Gain4'
   */
  rty_Out1[0] = 5.0;
  rty_Out1[1] = 10.0 * rtu_In1;

  /* Gain: '<S1>/Gain1' incorporates:
   *  Constant: '<S1>/Constant'
   */
  rty_Out2[0] = 150.0;
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  rty_Out2[1] = 15.0 * rtu_In3;
  rty_Out2[2] = 15.0 * rtu_In2[0];
  rty_Out2[3] = 15.0 * rtu_In2[1];
}

The Allow arguments (Match graphical interface) specification generates a predictable
interface and maps the function arguments with the graphical interface of the Subsystem block.
There are arrays as part of the function arguments to account for the combination of input or output
signals that th Mux block uses.

For the Enabled, Triggered, or Resettable Subsystem with Allow arguments (Match graphical
interface) specification, the generated function contains arguments corresponding to each Enable,
Trigger block, and/or Reset block present within that Subsystem.

Limitations

• The Function interface set as Allow arguments (Match graphical interface)
specification is not applicable to context menu option C/C++ > Build this Subsystem.

• You cannot control the argument names.

See Also

Related Examples
• Subsystem, Atomic Subsystem, CodeReuse Subsystem
• “Reduce Global Variables in Nonreusable Subsystem Functions” on page 73-8
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Referenced Models in Simulink Coder

• “Generate Code for Model Reference Hierarchy” on page 5-2
• “Set Configuration Parameters for Code Generation of Model Hierarchies” on page 5-9
• “Convert Subsystem to Referenced Model and Generate Code” on page 5-14
• “Generate Reusable Code from Model Reference Hierarchy” on page 5-17
• “Storage Classes for Parameters and Signals Used in Model Blocks” on page 5-20
• “Code Generation Limitations for Model Reference” on page 5-23
• “Simulink Cache Files for Incremental Code Generation” on page 5-25
• “Specify Instance-Specific Parameter Values for Reusable Referenced Model” on page 5-28
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Generate Code for Model Reference Hierarchy
To achieve incremental loading of models, incremental code generation, modular development of
referenced models, and code reuse, you can generate code for the model reference hierarchy.

You can include one model inside another model by using a Model block. Each instance of a Model
block is a model reference. For simulation and code generation, blocks within a referenced model
execute together as a unit. The model that contains a referenced model is a parent model. A
collection of parent and referenced models constitutes a model hierarchy.

Model Reference Technology
When you generate code for a referenced model hierarchy, the code generator produces a standalone
executable for the top model and a library module called a model reference target for each
referenced model. When the code executes, the top model executable invokes the model reference
targets to compute the referenced model output. Model reference targets are sometimes called
Simulink Coder targets.

Do not confuse a model reference target (Simulink Coder target) with these other types of targets:

• Target hardware — A platform for which the Simulink Coder software generates code.
• System target file — A file that instructs the Simulink Coder software how to generate code for

particular purpose.
• Rapid Simulation target (RSim) — A system target file that is part of the Simulink Coder product.
• Simulation target — A MEX file that implements a referenced model, which is executed by using

Simulink Accelerator™ software.

The code generator places the code for the top model in a hierarchy in the code generation folder and
places the code for referenced models in an slprj folder. Subfolders in slprj are separate places
for different types of files. For folder information, see “Manage Build Process Folders”.

By default, the Simulink Coder uses incremental code generation. When generating code, the
software compares structural checksums of referenced model files to the generated code files to
determine whether to regenerate model reference targets. To control when rebuilds occur, use the
configuration parameter Model Referencing > Rebuild. For details, see “Rebuild”.

The Simulink Coder software also uses incremental loading. The code for a referenced model is not
loaded into memory until the code for its parent model executes and requires the outputs of the
referenced model. Simulink Coder then loads the referenced model target and executes the code.
Once loaded, the target remains in memory until it is no longer used.

If you have Embedded Coder, custom targets must declare themselves as compliant with the model
reference if they support Model blocks. For more information, see “Support Model Referencing” on
page 86-60.

Generate Code for Model Reference Hierarchy
This example shows how to reference an existing model and generate code for the model reference
hierarchy.
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Create Model Reference Hierarchy

1. Open an existing model, for example the ex_model_arg_ref model. This model represents a
reusable algorithm. This is a GRT model. If you have Embedded Coder, change the model
configuration parameter System target file to ert.tlc.

open_system('ex_model_arg_ref');

2. A referenced model must specify that it is available to be referenced and whether it can be
referenced just once or multiple times. Specify the model configuration parameter “Total number of
instances allowed per top model” as One or Multiple. By default, Total number of instances
allowed per top model is set to Multiple.

3. Create a new model that you want as a top model in the model reference hierarchy. The top model
refers to other models as referenced models or multiple instances of a referenced model.

4. Add Inports and Outports to the top model as required. To add a referenced model, use the Model
block.

5. The new block is initially unresolved because it does not specify a referenced model. To open the
block parameters dialog box, double-click the Model block or use the context menu of the Model
block.
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6. Enter the name of the referenced model in the Model name field. This name must contain fewer
than 60 characters, exclusive of the .slx suffix.

7. Click OK. If the referenced model contains root-level inputs or outputs, the Model block displays
corresponding input and output ports.

8. Create another instance of the Model block so that the top model looks like model:

open_system('ex_model_arg');

9. Name the model ex_model_arg and save the model.
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You can also convert a subsystem to a referenced model. For more details, see “Convert Subsystems
to Referenced Models”.

Generate Code for Model Reference Hierarchy

1. Verify that the model configuration parameter Solver selection Type is set to Fixed-step for the
top model and the referenced model. To open the respective Configuration Parameters dialog boxes,
on the Modeling tab, select Model Settings for the respective models.

For a model reference hierarchy that has multiple referenced models, you can access the Model
Settings of the referenced model that is open and the top model through this menu. To access the
Model Settings of another referenced model in the model hierarchy, open the referenced model to
access this menu.

2. For the top model, open the C Code tab by selecting either Simulink Coder app or Embedded
Coder app. To generate code for the model reference hierarchy, click the Build button.

The Simulink Coder build process generates and compiles code. The current folder now contains new
files and a new folder.

• ex_model_arg_grt_rtw — The build folder containing the generated code for the top model.

• slprj > grt > ex_model_arg_ref — The folder containing the generated code for the
referenced model.

• ex_model_arg.exe — The executable created by the build process.

• ex_model_arg.slxc — The Simulink cache file for the top model.

• ex_model_arg_ref.slxc — The Simulink cache file for the referenced model.

For more information about the configuration parameter requirements, see “Set Configuration
Parameters for Code Generation of Model Hierarchies”.
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View Generated Code in Code Generation Report

To view the generated code, in the C Code tab, select Open Report. The code generation report
contains hyperlinks to all the files generated for the model reference hierarchy.

To open the generated code for the referenced model, click the referenced model hyperlink under the
Referenced Models section on the left pane.

To navigate back to the top model, click the Go Backward button on the top-left corner of the code
generation report window.

Working with Code Generation Folders
Model reference code is generated in your code generation folder. Simulation target code is
generated in your simulation cache folder. Due to the two different folders, there are constraints on:

• When and where you build model reference targets.
• How you access the model reference targets.
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You can store the models referenced by Model blocks anywhere on the MATLAB path. A top model
can include models stored on different file systems or in different folders. The simulation targets and
generated code derived from these models cannot be stored on different file systems or in different
folders. To allow code reuse, you must set up models referenced by a top model to simulate and
generate model reference target code in a single code generation folder.

If you reference the same model from several top models, each stored in a different folder, you must
choose one of these approaches:

• Work with the same code generation folder and be sure that the models are on your path.
• Allow separate code generation folders, simulation targets, and Simulink Coder targets to be

generated in each folder in which you work.

The second approach requires maintenance of several instances of the model reference code. It is
possible for generated code to become redundant, for example, when you make changes to the
referenced model. To minimize code regeneration of referenced models, choose a specific code
generation folder for all sessions.

Build Model Reference Targets
The code generator produces a model reference target directly from the Simulink model. The code
generator generates or regenerates model reference targets, for example, when they require an
update.

When you execute the slbuild command by using arguments in the MATLAB Command Window,
Simulink and Simulink Coder can generate a simulation target for an accelerator mode referenced
model and a model reference target for a referenced model.

The code generator produces only one model reference target for multiple instances of a referenced
model. For more information, see “Generate Reentrant Code from Subsystems”.

Reduce Change Checking Time

You can reduce the time that Simulink and Simulink Coder spend checking whether model reference
targets need to be rebuilt by setting configuration parameter values:

• In the top model, consider setting the model configuration parameter Model Referencing >
Rebuild to If any changes in known dependencies detected.

• In the referenced models throughout the hierarchy, set the configuration parameter Diagnostics
> Data Validity > Signal resolution to Explicit only or None.

These parameter values exist in a referenced model configuration set, not in the individual Model
block. Setting either value for an instance of a referenced model sets it for the instances of that
model.

See Also

Related Examples
• “Specify Instance-Specific Parameter Values for Reusable Referenced Model” on page 5-28
• “Establish Data Ownership in a Model Hierarchy” on page 35-10
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• “Use Configuration Reference to Select Code Generation Target” on page 46-11
• “Manage Simulation Targets for Referenced Models”
• “Generate Reentrant Code from Top Models” on page 7-18
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Set Configuration Parameters for Code Generation of Model
Hierarchies

A model reference hierarchy must satisfy various Simulink Coder requirements, as described in this
topic. A model referencing hierarchy to be processed by the Simulink Coder software must also
satisfy:

• The Simulink requirements listed in:

• “Set Configuration Parameters for Model Hierarchies”
• “Model Reference Interface and Boundary”

• The Simulink limitations listed in “Signal Requirements and Limitations”
• The Simulink Coder limitations listed in “Code Generation Limitations for Model Reference” on

page 5-23

Configuration Parameter Requirements
A referenced model uses a configuration set in the same way a top model does. By default, every
model in a hierarchy has its own configuration set, which it uses in the same way that it would if the
model executed independently.

Because each model can have its own configuration set, configuration parameter values can be
different in different models. Furthermore, some parameter values are intrinsically incompatible with
model referencing. The response of the code generator to an inconsistent or unusable configuration
parameter depends on the parameter:

• Where a parameter inconsistency has no significance, the code generator ignores or resolves the
inconsistency without posting a warning.

• Where a nontrivial and possibly acceptable solution exists to an inconsistent parameter, the code
generator resolves the conflict silently; resolves it with a warning; or generates an error.

• If an acceptable resolution is not possible, the code generator produces an error. You must then
change parameter values to eliminate the issue.

When a model reference hierarchy contains many referenced models that have incompatible
parameter values, or a changed parameter value must propagate to many referenced models,
manually eliminating configuration parameter incompatibilities can be time-consuming. You can
control or eliminate such overhead by using configuration references to assign an externally stored
configuration set to multiple models. For more information, see “Share a Configuration with Multiple
Models”.

To select a code generation target for a model reference hierarchy without modifying the individual
models, use a configuration reference in the Simulink data dictionary. For more information, see “Use
Configuration Reference to Select Code Generation Target” on page 46-11.

The following tables list configuration parameters that can cause problems if set in certain ways, or if
set differently in a referenced model than in a parent model. Where possible, the code generator
resolves violations of these requirements, but most cases require you to make changes to parameters
in your models.
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Configuration Requirements for Model Referencing with System Target Files

Dialog Box Pane Option Requirement
Solver Start time Some system target files require the start

time of models to be zero.
Hardware
Implementation

All options Values must be the same for top and
referenced models.

Code Generation System target file Must be the same for top and referenced
models.

Language Must be the same for top and referenced
models.

Generate code only Must be the same for top and referenced
models.

Identifiers Maximum identifier
length

Cannot be longer for a referenced model
than for its parent model.

Interface Code replacement
library

Must be the same for top and referenced
models.

Generate C API for
options

The C API check boxes that you select must
be the same for top and referenced models.

ASAP2 interface Can be on or off in a top model, but must
be off in a referenced model. If it is not
off, the code generator temporarily sets it
to off during code generation.
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Configuration Requirements for Model Referencing with ERT System Target Files (Requires
Embedded Coder)

Dialog Box Pane Option Requirement
Identifiers Global variables

Global types
Subsystem
methods
Local temporary
variables
Constant macros

$R token must be included.

Signal naming Must be the same for top and referenced models.
M-function If specified, must be the same for top and referenced

models.
Parameter naming Must be the same for top and referenced models.
#define naming Must be the same for top and referenced models.

Interface Ignore custom
storage classes

Must be the same for top and referenced models.

Support floating-
point numbers

Must be the same for top and referenced models.

Support non-finite
numbers

If off for top model, must be off for referenced
models.

Support complex
numbers

If off for top model, must be off for referenced
models.

Remove error
status field in real-
time model data
structure

If on for top model, must be on for referenced models.

Code Placement Use owner from
data object for
data definition
placement

Must be the same for top and referenced models.

Signal display level Must be the same for top and referenced models.
Parameter tune
level

Must be the same for top and referenced models.

Configuration Parameters Changed During Code Generation
For referenced models, if these Configuration Parameters > Code Generation > Identifiers
parameters have settings that do not contain a $R token (which represents the name of the
referenced model), code generation prepends the $R token to the identifier format:

• Global variables (CustomSymbolStrGlobalVar)
• Global types (CustomSymbolStrType)
• Subsystem methods (CustomSymbolStrFcn)
• Constant macros (CustomSymbolStrMacro)
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You can use the Model Advisor to identify models in a model referencing hierarchy for which code
generation changes configuration parameter settings.

1 In the Simulink Editor, from the Modeling tab, select Model Advisor.
2 Select By Task.
3 Run the Check code generation identifier formats used for model reference check.

If a script that operates on generated code uses identifier formats that code generation changes, then
update the script to use the updated identifier format (which includes an appended $R token).

For more information about identifiers, see “Identifier Format Control” on page 53-15.

Naming Requirements
Within a model that uses model referencing, names of the constituent models cannot collide. When
you generate code from a model that uses model referencing, the Maximum identifier length
parameter must be large enough to accommodate the root model name and the name-mangling text.
A code generation error occurs if Maximum identifier length is not large enough.

When a name conflict occurs between a symbol within the scope of a higher-level model and a symbol
within the scope of a referenced model, the symbol from the referenced model is preserved. The code
generator performs name mangling on the symbol from the higher-level model.

Embedded Coder Naming Requirements

The Embedded Coder product lets you control the formatting of generated symbols in much greater
detail. When generating code with an ERT target from a model that uses model referencing:

• The $R token (in addition to the $M token) must be included in the Identifier format control
parameter specifications except for Shared utilities identifier format.

• The Maximum identifier length must be large enough to accommodate full expansions of the $R
and $M tokens.

For more information, see “Model Configuration Parameters: Code Generation Identifiers”.

Custom Target Requirements
If you have Embedded Coder, a custom target must meet various requirements to support model
referencing. For details, see “Support Model Referencing” on page 86-60.

Miscellaneous Considerations
Minimize occurrences of algebraic loops by selecting the Minimize algebraic loop occurrences
parameter on the Model Referencing pane. The setting of this option affects only generation of code
from the model. For more information about direct feed through, see “Algebraic Loop Concepts”.

Use the Integer rounding mode parameter on your model's blocks to simulate the rounding
behavior of the C compiler that you intend to use to compile code generated from the model. This
setting appears on the Signal Attributes pane of the parameter dialog boxes of blocks that can
perform signed integer arithmetic, such as the Product and n-D Lookup Table blocks.
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For most blocks, the value of Integer rounding mode completely defines rounding behavior. For
blocks that support fixed-point data and the Simplest rounding mode, the value of Signed integer
division rounds to also affects rounding. For details, see “Rounding” (Fixed-Point Designer).

See Also

Related Examples
• “Manage Configuration Sets for a Model”
• “Set Configuration Parameters for Model Hierarchies”
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Convert Subsystem to Referenced Model and Generate Code
Converting subsystems to referenced models enhances incremental code generation, modular
development of referenced models, and code reuse. Many large models use a combination of
referenced models and subsystems.

To convert a Subsystem block to a Model block, use any of these methods:

• In the Simulink Editor, select a Subsystem block. On the Simulink Toolstrip, the Subsystem Block
tab, select Convert > Model Block.

• In the MATLAB Command Window, use the Simulink.SubSystem.convertToModelReference
function with the 'UseConversionAdvisor' argument set to true.

Before you convert a subsystem to a referenced model:

1 Configure the Subsystem block as an atomic subsystem. In the Subsystem Block Parameters,
select the Treat as atomic unit property.

An atomic subsystem executes as a unit relative to the parent model. Subsystem execution does
not interleave with parent block execution. This property makes it possible to extract subsystems
for use as standalone models and as functions in the generated code.

2 Set the model configuration parameter Signal resolution to Explicit only or None.

You can map a storage class to a category of model data elements or to an individual element by
using the Code Mappings editor or the Code Mappings API (coder.mapping.api.CodeMapping).
Then use the Property Inspector or the API to specify code configurations settings specific for that
storage class, such as header files, definition files, and memory sections. If your model contains code
mappings, you can migrate the code mappings when you convert a subsystem to a referenced model.
For more information, see Code Mappings editor.

Configure Code Mappings
1 Open the example model rtwdemo_roll.

rtwdemo_roll
2 On the Simulink toolstrip, the Apps tab, select the Embedded Coder or Simulink Coder app.
3 In the C Code tab, click Code Interface > Default Code Mappings. This option pins the Code

Mappings editor and the Property Inspector pane.
4 Map a storage class to a category of model data element. In the Code Mappings editor, select the

Data Defaults tab. For the Inports category, specify the Storage Class as ExportedGlobal.

Alternatively, to configure the default mapping for Inports, in the MATLAB Command Window, enter:

roll_mapping = coder.mapping.api.get('rtwdemo_roll');
setDataDefault(roll_mapping,'Inports','StorageClass','ExportedGlobal');

Convert Subsystem to Referenced Model
1 To convert a subsystem to a referenced model, open the Model Reference Conversion Advisor.

Select the subsystem HeadingMode. On the Subsystem Block tab, select Convert > Model
Block.
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The Model Reference Conversion Advisor enables you to interactively specify conversion
parameters and fix issues that the advisor finds.

2 Review the autopopulated model name. If needed, you can update this name.
3 To make the conversion process faster, select the Fix errors automatically (if possible). This

option fixes some conversion issues. You do not control the fixes.
4 To copy the code mappings specified for the model, select the Copy code mappings option. This

option migrates the code mappings from the parent model to the newly converted referenced
model. By default, this option is cleared.

5 Click Convert.

The Model Reference Conversion Advisor steps through each of the checks. Address any issues
that the advisor reports. After the Model Reference Conversion Advisor successfully completes
the conversion, it replaces the Subsystem block with a Model block that references the new
model.

Alternatively, to convert a subsystem to a referenced model, in the MATLAB Command Window, enter:

Simulink.SubSystem.convertToModelReference(...
   'rtwdemo_roll/HeadingMode', ...
   'HeadingMode', ...
   'AutoFix',true,...
   'ReplaceSubsystem',true,...
   'CopyCodeMappings',true);
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Copy Code Mappings After Subsystem Conversion
If you want to copy the code mappings from the parent model to the referenced model and you did
not previously select the Copy code mappings option in the Model Reference Conversion Advisor, in
the MATLAB Command Window, enter:

roll_mapping = coder.mapping.api.get('rtwdemo_roll');
roll_sc = getDataDefault(roll_mapping,'Inports','StorageClass');

mode_mapping = coder.mapping.api.get('HeadingMode');
setDataDefault(mode_mapping,'Inports','StorageClass',roll_sc);

Review Generated Code
For the rtwdemo_roll, model which contains the referenced model HeadingMode, open the C Code
tab. To generate code for the model reference hierarchy, click Build.

The Simulink Coder build process generates and compiles code. The current folder now contains new
files and a new folder.

Folder or File Purpose
rtwdemo_roll_grt_rtw The build folder containing the generated code

for the top model.
slprj > grt > Heading Mode The build folder containing the generated code

for the referenced model.
rtwdemo_roll.exe The executable created by the build process.
rtwdemo_roll.slxc The Simulink cache file for the top model.
HeadingMode.slxc The Simulink cache file for the referenced model.

See Also

Related Examples
• “Generate Code for Model Reference Hierarchy” on page 5-2
• “Convert Subsystems to Referenced Models”
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Generate Reusable Code from Model Reference Hierarchy
A reusable subsystem function that has input or output connected to the root Inport or Outport block
of a referenced model can impact code reuse. It can prevent you from reusing atomic subsystems in a
reference model context in the same way you might reuse the subsystems in a standalone model.

This example shows how to generate reusable code when you have a reusable subsystem referenced
inside Model block.

Generate Reusable Code for Subsystem

1. Convert these blocks into a subsystem. Drag a box to outline the subsystem that you want to
create. From the Multiple tab on the Simulink Editor toolstrip, select Create Subsystem.

2. Make these changes to the Subsystem block parameters:

• Select “Treat as atomic unit”.
• On the Code Generation tab, set “Function packaging” to Reusable function.

3. Create a model that includes three instances of the preceding subsystem.

4. Set the model configuration parameter “Default parameter behavior” to Inlined.

5. To build the model and generate code, press Ctrl+B.

The code generator optimizes the code by generating one copy of the function for the reused
subsystem in the model.c file.

void ex_codeReuseThreeSubsys_Subsystem1(real_T rtu_In1,
  B_Subsystem1_ex_codeReuseThreeSubsys_T *localB)
{
  /* Gain: '<S1>/Gain' */
  localB->Gain = 3.0 * rtu_In1;
}
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Generate Reusable Code for Subsystem in Referenced Model

1. Create a top model by using a Model block that references the preceding model that has three
instances of the reusable subsystem.

2. Generate code for the top model. The code generator generates three different function signatures
in the slprj folder.

/* Output and update for atomic system: '<Root>/Subsystem 1' */
void ex_codeReuseThreeSubsys_Subsystem1(const real_T *rtu_In1,
  B_Subsystem1_ex_codeReuseThreeSubsys_T *localB)
{
  /* Gain: '<S1>/Gain' */
  localB->Gain = 3.0 * *rtu_In1;
}

/* Output and update for atomic system: '<Root>/Subsystem 2' */
void ex_codeReuseThreeSubsys_Subsystem2(real_T rtu_In1,
  B_Subsystem2_ex_codeReuseThreeSubsys_T *localB)
{
  /* Gain: '<S2>/Gain' */
  localB->Gain = 3.0 * rtu_In1;
}

/* Output and update for atomic system: '<Root>/Subsystem 3' */
void ex_codeReuseThreeSubsys_Subsystem3(real_T rtu_In1, real_T *rty_Out1)
{
  /* Gain: '<S3>/Gain' */
  *rty_Out1 = 3.0 * rtu_In1;
}

3. To enable the subsystem functions for code reuse, insert Signal Conversion blocks into the
referenced model. Place one block between the Inport and Subsystem 1 and another block between
Subsystem 3 and the Outport.
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If the subsystem has a Merge block with initial conditions, do not add a Signal Conversion block.
Instead, add a Bias block to obtain a reusable function.

4. Select the model configuration parameter “Pass fixed-size scalar root inputs by value for code
generation”.

5. Generate code for the top model. The code generator generates a single reusable function in the
slprj folder.

void ex_codeReuseSubsysSigConvert_Subsystem1(real_T rtu_In1,
  B_Subsystem1_ex_codeReuseSubsysSigConvert_T *localB,
  P_Subsystem1_ex_codeReuseSubsysSigConvert_T *localP)
{
  /* Gain: '<S1>/Gain' */
  localB->Gain = localP->Gain_Gain * rtu_In1;
}

See Also

Related Examples
• “Convert Subsystems to Referenced Models”
• “Reference Existing Models”
• “Generate Reusable Code from Library Subsystems Shared Across Models”
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Storage Classes for Parameters and Signals Used in Model
Blocks

To transfer data between your referenced model and top model, use signals and parameters. You can
also use parameters to integrate external data into the model reference hierarchy. To include one
model inside another model and create a model reference hierarchy, use a Model block.

You can apply a storage class to a data item in a model, such as signal or parameter, to:

• Make the data item appear in the generated code as a global symbol, typically a global variable.
• Prevent optimizations such as Default parameter behavior and Signal storage reuse from

eliminating the data item from the generated code.

For examples, see “C Code Generation Configuration for Model Interface Elements” on page 33-2.

You can map a storage class to a category of model data elements or to an individual element by
using the Code Mappings editor or the Code Mappings API (coder.mapping.api.CodeMapping).
To specify code configurations settings specific to that storage class, such as header files, definition
files, and memory sections, use the Property Inspector or the API. For more information, see Code
Mappings editor.

Storage Classes for Parameters in Model Blocks
Models containing Model blocks can use storage classes for parameters to interface with external
code. Storage classes, with the exception of Auto, are tunable. The supported storage classes
include:

• Predefined storage classes in Simulink Coder and Embedded Coder
• A new storage class created by using the Embedded Coder Dictionary

For limitations on Embedded Coder storage classes, see “Storage Class Limitations”.

The restrictions on parameters in referenced models are:

• Tunable parameters are not supported for noninlined S-functions.
• Tunable parameters set through the Model Parameter Configuration dialog box are ignored.

Concerning how global tunable parameters are declared, defined, and used in code generated for
targets. consider:

• A global tunable parameter is a parameter in the base workspace that has a storage class other
than Auto.

• An extern declaration is generated for models that use a given parameter.
• If a parameter is exported, the top model defines (allocates memory for) the parameter whether

the top model uses the parameter or not.
• Global parameters are accessed directly as global memory. They are not passed as arguments to

the functions that are generated for the referenced models.
• In a referenced model that sets the default storage class for a category of parameter data to

Default in the Code Mapping editor, symbols for Model default parameters are generated by
using unstructured variables (rtP_xxx) instead of being written into the model_P structure. You
can then compile each referenced model independently.
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Parameters that you use as Model block arguments must be defined in the referenced model
workspace. For details, see “Parameterize Instances of a Reusable Referenced Model”.

Storage Classes for Signals in Model Blocks
Models containing Model blocks can use signals of storage class Auto.

A global signal is a signal that has a storage class other than Auto. The supported storage classes
include:

• Predefined storage classes in Simulink Coder and Embedded Coder
• A new storage class created by using Embedded Coder Dictionary

If you have Embedded Coder, you can create a global signal by using a storage class defined in the
Embedded Coder Dictionary that has Storage Type set as Unstructured or by creating a storage in
the Embedded Coder Dictionary that has Storage Type set as Unstructured.

These signals are distinct from individual signals that use the storage class Model default. When
you set the default storage class of the corresponding data category to Default in the Code Mapping
editor, these signals are treated as test points that have the Auto storage class.

When you declare signals as global, be aware of how the signal data is handled. Global signals are
declared, defined, and used as follows:

• An extern declaration is generated for models that use a global signal.

As a result, if a signal crosses a Model block boundary, the top model and the referenced model
both generate extern declarations for the signal.

• For an exported signal, the top model defines (allocates memory for) the signal, whether or not the
top model itself uses the signal.

• Global signals used by a referenced model are accessed directly as global memory. They are not
passed as arguments to the functions that are generated for the referenced models.

Storage classes that you create by using the Embedded Coder Dictionary also follow the preceding
rules for the top model.

Note In a referenced model, you cannot use the storage class that you create by using the Embedded
Coder Dictionary on root-level Inports and Outports.

Certain storage classes have limited support for use with model reference. See “Storage Class
Limitations”.

Signal Name Mismatches Across Model Reference Boundary
Within a parent model, the name and storage class for a signal entering or leaving a Model block
might not match those of the signal attached to the root inport or outport within that referenced
model. Because referenced models are compiled independently without regard to a parent model,
they cannot adapt to the possible variations in how parent models label and store signals.

The code generator accepts cases where input and output signals in a referenced model have the
Auto storage class. When such signals are test pointed or are global, certain restrictions apply. This
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table describes how mismatches in signal labels and storage classes between parent and referenced
models are handled by the software.

Relationships of Signals and Storage Classes Across Model Reference Boundary

Storage Class in
Referenced Model

Storage Class in
Parent Model

Signal Passing
Method

Signal Mismatch
Checking

Auto Non-Auto Function argument Signal label mismatch
Model default (when
the Code Mapping
editor specifies
Default storage class)
or resolved to Signal
Object

Non-Auto Function argument Signal label mismatch

Non-Auto Auto Global variable None
Non-Auto Non-Auto Global variable One of the storage

classes must be Auto
(otherwise there is an
error)

These signal resolution rules apply to code generation:

• If the storage class of a root input or output signal in a referenced model is Auto or Model
default (when you set the storage class of the corresponding data category to Default in the
Code Mapping editor), the signal is passed as a function argument. When such a signal is Non-
Auto or resolves to a Simulink.Signal object in the parent model, the Signal label mismatch
diagnostic is applied.

• If a root input or output signal in a referenced model is global, the signal is communicated by
using direct memory access (global variable). The corresponding signal in the parent model must
be Auto.

• You cannot use a storage class that you create by using the Embedded Coder Dictionary in a
referenced model.

You can set the model configuration parameter Signal label mismatch diagnostic to error,
warning, or none.

See Also
“Signal label mismatch”

Related Examples
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “C Code Generation Configuration for Model Interface Elements”
• “Establish Data Ownership in a Model Hierarchy” on page 35-10
• “Flexible Storage Class for Different Model Hierarchy Contexts” on page 31-28
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Code Generation Limitations for Model Reference
Code generation limitations for model references influence how you properly set up the model
reference hierarchy for code generation.

In addition to these limitations, a model reference hierarchy used for code generation must satisfy:

• The Simulink requirements and limitations listed in:

• “Configuration Requirements for All Referenced Model Simulation”
• “Model Reference Requirements and Limitations”
• “Model Reference Interface and Boundary”

• The Simulink Coder requirements applicable to the code generation target, as listed in
“Configuration Parameter Requirements” on page 5-9.

Storage Class Limitations
If you have Embedded Coder, some restrictions exist on grouped storage classes in referenced
models. For details, see “Storage Class Limitations”.

Data Logging Limitations
• To Workspace blocks and Scope blocks are ignored when Simulink Coder generates code for a

referenced model. The resulting code is the same as if the blocks did not exist. In some cases for
models with Scope block and MAT-file logging enabled, the code generator produces an extra
PWork in the model's DWork structure.

• Code generated for referenced models cannot log data to MAT-files. If you enable data logging for
a referenced model, Simulink Coder disables the option before code generation and re-enables it
afterward.

• If you log states for a model that contains referenced models, the ordering of the states in the
output is determined by block sorted order, and might not match between simulation output and
generated code MAT-file logging output.

State Initialization Limitations
When a top model uses the model configuration parameter Initial state to specify initial conditions,
Simulink Coder does not initialize the discrete states of the referenced models during code
generation.

Model Reuse Limitations
If a referenced model used for code generation has at least one of the following characteristics, the
model must specify the model configuration parameter Total number of instances allowed per top
model as One. Other instances of the model can exist in the hierarchy. If you do not set the
parameter to One, or more than one instance of the model exists in the hierarchy, an error occurs.
The characteristics are:

• The model references another model that has been set to a single instance.
• The model contains an internal signal or state that has a storage class that is not supported for

multi-instance models. You must set the storage class to Auto or Model default for internal
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signals and states. The default storage class for internal data must be a multi-instance storage
class.

• The model uses at least one of these Stateflow constructs:

• Machine-parented data
• Machine-parented events
• Exported Stateflow graphical functions

• The model contains an S-function that is:

• Inlined but you have not set the option SS_OPTION_WORKS_WITH_CODE_REUSE
• Not inlined

• The model contains a function-call subsystem that:

• The Simulink engine forces to be a function
• Is called by a wide signal

S-Functions Limitations
• A referenced model cannot use noninlined S-functions generated by Simulink Coder.
• The Simulink Coder S-function target does not support model referencing.

For additional information, see “S-Functions in Referenced Models”.

Subsystems Limitations
If you generate code for an atomic subsystem as a reusable function, inputs or outputs that connect
the subsystem to a referenced model might prevent code reuse, as described in “Generate Reentrant
Code from Subsystems”.

Targets Limitation
The Simulink Coder S-function target does not support model referencing.

Conditional Models Limitation
When a model contains a trigger or enable port, you cannot generate standalone Simulink Coder
code.

See Also

Related Examples
• “Set Configuration Parameters for Code Generation of Model Hierarchies” on page 5-9
• “Set Configuration Parameters for Model Hierarchies”
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Simulink Cache Files for Incremental Code Generation
Share the generated code for various target types between team members inside an organization by
using Simulink cache files. When you generate code from a Simulink model hierarchy, each
referenced model has an associated Simulink cache file. These files have an .slxc file extension. The
cache files contain artifacts from the build that can reduce the time required for successive model
simulation and code generation. Simulink cache files are generated when you simulate models in
accelerator or rapid accelerator mode or generate code for models. For more information, see “Share
Simulink Cache Files for Faster Simulation”.

Contents of Simulink Cache Files
At the end of a build, the code generator packages the artifacts and generated code for the model
hierarchy in the Simulink cache files. The cached artifacts include:

• Shared utilities
• All files under the slprj\system_target_file\model_name
• model_name_rtw_system_target_file folder for the top model
• Any binaries generated for the top model

You cannot modify the contents of the Simulink cache files. If you update the build artifacts inside the
slprj folder, the Simulink cache file picks up these updates during the next build cycle.

Share Code Generation Artifacts
If you are involved in team development of large models that reference other models, use Simulink
cache files to synchronize builds and share generated code artifacts to enhance incremental code
generation. You can leverage Simulink cache files to avoid unnecessary code generation.

For example, assume that you collaborate with your team members by using a source control system
and your models are built every night in a continuous integration system.

1 Open your model. For example, rtwdemo_mdlreftop.
2 Build the model. On the C Code tab, click Build.

Observe the Simulink cache files generated for all referenced models. The rtwdemo_mdlrefbot
model is a referenced model in rtwdemo_mdlreftop.
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Simulink stores cache files in the folder specified by the Simulation cache folder preference.

To see all supported configurations, double-click the cache file. The Simulink cache report
contains information related to each release, platform, and list of packaged targets.

Alternatively, to get the contents of the Simulink cache file in a MATLAB table, use the slxcinfo
function.

3 Submit your models to the source control system. The continuous integration system builds the
models overnight and updates the existing Simulink cache files.

Note Because Simulink cache files are derived files, do not submit them to source control. If you
share Simulink cache files by storing them in a source control system, you cannot diff or merge
different versions of these files.

4 Assume your team member made some changes to the model and submitted the changes to the
source control system. When you want to work with the model hierarchy, fetch these files:

• Design files (model and associated files) from the source control system.
• Simulink cache files from the continuous integration system.

5 Make your changes to the model.
6 Build the model. The code generator extracts code generation artifacts stored in the Simulink

cache files from the overnight build and avoids unnecessary rebuilds and code regeneration.

The time to build the model and generate code is less than the first time that you built the model.

Note To unpack the simulation and code generation targets from the Simulink cache files
without updating, simulating, or generating code for the model hierarchy, use the slxcunpack
function.

7 Submit your updated model files to the source control system.
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See Also
slxcinfo | slxcunpack

Related Examples
• “Share Simulink Cache Files for Faster Simulation”
• “Reduce Build Time for Referenced Models by Using Parallel Builds” on page 57-36

More About
• “Pull, Push, and Fetch Files with Git”

External Websites
• Simulink Cache (1 min, 27 sec)
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Specify Instance-Specific Parameter Values for Reusable
Referenced Model

When you use model referencing to break a large system into components, each component is a
separate model. You can reuse a component by referring to it with multiple Model blocks. Each Model
block is an instance of the component. You can then configure a block parameter (such as the Gain
parameter of a Gain block) to use either the same value or a different value for each instance of the
component. To use different values, create and use a model argument to set the value of the block
parameter.

When you generate code from a model hierarchy that uses model arguments, the arguments appear
in the code as formal parameters of the referenced model entry-point functions, such as the output
(step) function. The generated code then passes the instance-specific parameter values, which you
specify in each Model block, to the corresponding function calls.

Whether you use or do not use model arguments, you can use storage classes to configure block
parameters to appear in the generated code as tunable global variables. You can also use storage
classes to generate tunable model argument values, which the generated code stores in memory and
passes to the function calls. You can then change the values during execution.

Pass Parameter Data to Referenced Model Entry-Point Functions as
Arguments
Configure a referenced model to accept parameter data through formal parameters of the generated
model entry-point function. This technique enables you to specify a different parameter value for each
instance (Model block) of the referenced model.

Configure Referenced Model to Use Model Arguments

Open the model ex_arg_code_ref. This model represents a reusable algorithm.

open_system('ex_arg_code_ref')

On the Modeling tab, click Model Data Editor.

In the Model Data editor, in the data table, use the Data Type column to set the data type of the
Inport block to single. Due to data type inheritance, the other signals in the model use the same
data type.
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Select the Parameters tab.

In the model, select the Gain block.

In the Model Data Editor, use the Value column to set the value of the Gain parameter to gainArg.

Next to gainArg, click the action button (3 vertical dots) and select Create.

In the Create New Data dialog box, set Value to Simulink.Parameter and Location to Model
Workspace. Click Create.

In the property dialog box, set Value to a number, for example, 3.17. Click OK.

Use the Model Data Editor to set the Numerator parameter by using a Simulink.Parameter
object named coeffArg whose value is 1.05. As with gainArg, store the parameter object in the
model workspace.

In the Model Data Editor, click the Show/refresh additional information button.

Use the Filter contents box to find each parameter object (gainArg and coeffArg). For each
object, select the check box in the Argument column.

Save the ex_arg_code_ref model.

Alternatively, at the command prompt, you can use these commands to configure the blocks and the
parameter objects:

set_param('ex_arg_code_ref/In1','OutDataTypeStr','single')

set_param('ex_arg_code_ref/Gain','Gain','gainArg')
modelWorkspace = get_param('ex_arg_code_ref','ModelWorkspace');
assignin(modelWorkspace,'gainArg',Simulink.Parameter(3.17));

set_param('ex_arg_code_ref/Discrete Filter','Numerator','coeffArg')
assignin(modelWorkspace,'coeffArg',Simulink.Parameter(1.05));

set_param('ex_arg_code_ref','ParameterArgumentNames','coeffArg,gainArg')

save_system('ex_arg_code_ref')

Specify Instance-Specific Parameter Values in Model Blocks

Open the model ex_arg_code. This model uses multiple instances (Model blocks) of the reusable
algorithm.

open_system('ex_arg_code')
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In the model, open the Model Data Editor Parameters tab (Modeling > Model Data Editor). The
Model Data Editor shows four rows that correspond to the model arguments, coeffArg and
gainArg, that you can specify for the two Model blocks.

Use the Model Data Editor to set values for the model arguments in Model. For example, use the
values in the figure. For Model1, do not specify a value for the model arguments. By default, a model
argument uses the last value specified below it in the model hierarchy (indicated by the value from
below).

Alternatively, at the command prompt, you can use this command to set the values for Model:

set_param('ex_arg_code/Model','ParameterArgumentValues',...
    struct('coeffArg','0.98','gainArg','2.98'))

Generate code from the top model.

slbuild('ex_arg_code')

### Starting serial model reference code generation build
### Successfully updated the model reference code generation target for: ex_arg_code_ref
### Starting build procedure for: ex_arg_code
### Successful completion of build procedure for: ex_arg_code

Build Summary

Code generation targets built:
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Model            Action                       Rebuild Reason                     
=================================================================================
ex_arg_code_ref  Code generated and compiled  ex_arg_code_ref.c does not exist.  

Top model targets built:

Model        Action                       Rebuild Reason                                    
============================================================================================
ex_arg_code  Code generated and compiled  Code generation information file does not exist.  

2 of 2 models built (0 models already up to date)
Build duration: 0h 0m 27.712s

The file ex_arg_code_ref.c defines the referenced model entry-point function,
ex_arg_code_ref. The function has two formal parameters, rtp_coeffArg and rtp_gainArg,
that correspond to the model arguments, coeffArg and gainArg. The formal parameters use the
data type real32_T, which corresponds to the data type single in Simulink.

file = fullfile('slprj','grt','ex_arg_code_ref','ex_arg_code_ref.c');
rtwdemodbtype(file,'/* Output and update for referenced model:',...
    'real32_T rtp_gainArg)',1,1)

/* Output and update for referenced model: 'ex_arg_code_ref' */
void ex_arg_code_ref(const real32_T *rtu_In1, real32_T *rty_Out1, real32_T
                     rtp_coeffArg, real32_T rtp_gainArg, DW_ex_arg_code_ref_f_T *
                     localDW)
{
  real32_T rtb_Sum;

  /* Sum: '<Root>/Sum' incorporates:
   *  UnitDelay: '<Root>/Unit Delay'
   */
  rtb_Sum = *rtu_In1 + localDW->UnitDelay_DSTATE;

  /* Gain: '<Root>/Gain' */
  rtb_Sum *= rtp_gainArg;

  /* DiscreteFilter: '<Root>/Discrete Filter' */
  localDW->DiscreteFilter_tmp = rtb_Sum - 0.5F * localDW->DiscreteFilter_states;
  *rty_Out1 = rtp_coeffArg * localDW->DiscreteFilter_tmp;

  /* Update for UnitDelay: '<Root>/Unit Delay' */
  localDW->UnitDelay_DSTATE = rtb_Sum;

  /* Update for DiscreteFilter: '<Root>/Discrete Filter' */
  localDW->DiscreteFilter_states = localDW->DiscreteFilter_tmp;
}

/* Model initialize function */
void ex_arg_code_ref_initialize(const char_T **rt_errorStatus,
  RT_MODEL_ex_arg_code_ref_T *const ex_arg_code_ref_M, DW_ex_arg_code_ref_f_T
  *localDW)
{
  /* Registration code */

  /* initialize error status */
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  rtmSetErrorStatusPointer(ex_arg_code_ref_M, rt_errorStatus);

  /* states (dwork) */
  (void) memset((void *)localDW, 0,
                sizeof(DW_ex_arg_code_ref_f_T));
}

The file ex_arg_code.c contains the definition of the top model entry-point function, ex_arg_code.
This function calls the referenced model entry-point function, ex_arg_code_ref, and uses the
model argument values that you specified (such as 1.11 and 3.34) as the values of rtp_coeffArg
and rtp_gainArg.

file = fullfile('ex_arg_code_grt_rtw','ex_arg_code.c');
rtwdemodbtype(file,'/* ModelReference: ''<Root>/Model'' incorporates:',...
    '1.05F, 3.17F)',1,1)

  /* ModelReference: '<Root>/Model' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out1'
   */
  ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out1, 0.98F, 2.98F,
                  &(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* ModelReference: '<Root>/Model1' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out2'
   */
  ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out2, 1.05F, 3.17F,
                  &(ex_arg_code_DW.Model1_InstanceData.rtdw));

  /* Matfile logging */
  rt_UpdateTXYLogVars(ex_arg_code_M->rtwLogInfo,
                      (&ex_arg_code_M->Timing.taskTime0));

  /* signal main to stop simulation */
  {                                    /* Sample time: [0.2s, 0.0s] */
    if ((rtmGetTFinal(ex_arg_code_M)!=-1) &&
        !((rtmGetTFinal(ex_arg_code_M)-ex_arg_code_M->Timing.taskTime0) >
          ex_arg_code_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(ex_arg_code_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
  if (!(++ex_arg_code_M->Timing.clockTick0)) {
    ++ex_arg_code_M->Timing.clockTickH0;
  }

  ex_arg_code_M->Timing.taskTime0 = ex_arg_code_M->Timing.clockTick0 *
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    ex_arg_code_M->Timing.stepSize0 + ex_arg_code_M->Timing.clockTickH0 *
    ex_arg_code_M->Timing.stepSize0 * 4294967296.0;
}

/* Model initialize function */
void ex_arg_code_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)ex_arg_code_M, 0,
                sizeof(RT_MODEL_ex_arg_code_T));
  rtmSetTFinal(ex_arg_code_M, 10.0);
  ex_arg_code_M->Timing.stepSize0 = 0.2;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    ex_arg_code_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(ex_arg_code_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(ex_arg_code_M->rtwLogInfo, (NULL));
    rtliSetLogT(ex_arg_code_M->rtwLogInfo, "tout");
    rtliSetLogX(ex_arg_code_M->rtwLogInfo, "");
    rtliSetLogXFinal(ex_arg_code_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(ex_arg_code_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(ex_arg_code_M->rtwLogInfo, 0);
    rtliSetLogMaxRows(ex_arg_code_M->rtwLogInfo, 0);
    rtliSetLogDecimation(ex_arg_code_M->rtwLogInfo, 1);

    /*
     * Set pointers to the data and signal info for each output
     */
    {
      static void * rt_LoggedOutputSignalPtrs[] = {
        &ex_arg_code_Y.Out1,
        &ex_arg_code_Y.Out2
      };

      rtliSetLogYSignalPtrs(ex_arg_code_M->rtwLogInfo, ((LogSignalPtrsType)
        rt_LoggedOutputSignalPtrs));
    }

    {
      static int_T rt_LoggedOutputWidths[] = {
        1,
        1
      };

      static int_T rt_LoggedOutputNumDimensions[] = {
        1,
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        1
      };

      static int_T rt_LoggedOutputDimensions[] = {
        1,
        1
      };

      static boolean_T rt_LoggedOutputIsVarDims[] = {
        0,
        0
      };

      static void* rt_LoggedCurrentSignalDimensions[] = {
        (NULL),
        (NULL)
      };

      static int_T rt_LoggedCurrentSignalDimensionsSize[] = {
        4,
        4
      };

      static BuiltInDTypeId rt_LoggedOutputDataTypeIds[] = {
        SS_SINGLE,
        SS_SINGLE
      };

      static int_T rt_LoggedOutputComplexSignals[] = {
        0,
        0
      };

      static RTWPreprocessingFcnPtr rt_LoggingPreprocessingFcnPtrs[] = {
        (NULL),
        (NULL)
      };

      static const char_T *rt_LoggedOutputLabels[] = {
        "",
        "" };

      static const char_T *rt_LoggedOutputBlockNames[] = {
        "ex_arg_code/Out1",
        "ex_arg_code/Out2" };

      static RTWLogDataTypeConvert rt_RTWLogDataTypeConvert[] = {
        { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 },

        { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 }
      };

      static RTWLogSignalInfo rt_LoggedOutputSignalInfo[] = {
        {
          2,
          rt_LoggedOutputWidths,
          rt_LoggedOutputNumDimensions,
          rt_LoggedOutputDimensions,
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          rt_LoggedOutputIsVarDims,
          rt_LoggedCurrentSignalDimensions,
          rt_LoggedCurrentSignalDimensionsSize,
          rt_LoggedOutputDataTypeIds,
          rt_LoggedOutputComplexSignals,
          (NULL),
          rt_LoggingPreprocessingFcnPtrs,

          { rt_LoggedOutputLabels },
          (NULL),
          (NULL),
          (NULL),

          { rt_LoggedOutputBlockNames },

          { (NULL) },
          (NULL),
          rt_RTWLogDataTypeConvert
        }
      };

      rtliSetLogYSignalInfo(ex_arg_code_M->rtwLogInfo, rt_LoggedOutputSignalInfo);

      /* set currSigDims field */
      rt_LoggedCurrentSignalDimensions[0] = &rt_LoggedOutputWidths[0];
      rt_LoggedCurrentSignalDimensions[1] = &rt_LoggedOutputWidths[1];
    }

    rtliSetLogY(ex_arg_code_M->rtwLogInfo, "yout");
  }

  /* states (dwork) */
  (void) memset((void *)&ex_arg_code_DW, 0,
                sizeof(DW_ex_arg_code_T));

  /* external inputs */
  ex_arg_code_U.In1 = 0.0F;

  /* external outputs */
  (void) memset((void *)&ex_arg_code_Y, 0,
                sizeof(ExtY_ex_arg_code_T));

  /* Model Initialize function for ModelReference Block: '<Root>/Model' */
  ex_arg_code_ref_initialize(rtmGetErrorStatusPointer(ex_arg_code_M),
    &(ex_arg_code_DW.Model_InstanceData.rtm),
    &(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* Model Initialize function for ModelReference Block: '<Root>/Model1' */
  ex_arg_code_ref_initialize(rtmGetErrorStatusPointer(ex_arg_code_M),
    &(ex_arg_code_DW.Model1_InstanceData.rtm),
    &(ex_arg_code_DW.Model1_InstanceData.rtdw));

  /* Matfile logging */
  rt_StartDataLoggingWithStartTime(ex_arg_code_M->rtwLogInfo, 0.0, rtmGetTFinal
    (ex_arg_code_M), ex_arg_code_M->Timing.stepSize0, (&rtmGetErrorStatus
    (ex_arg_code_M)));

  /* SystemInitialize for ModelReference: '<Root>/Model' incorporates:
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   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out1'
   */
  ex_arg_code_ref_Init(&(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* SystemInitialize for ModelReference: '<Root>/Model1' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out2'
   */
  ex_arg_code_ref_Init(&(ex_arg_code_DW.Model1_InstanceData.rtdw));
}

/* Model terminate function */
void ex_arg_code_terminate(void)
{
  /* (no terminate code required) */
}

The formal parameters use the data type real32_T (single) because:

1 The block parameters in ex_arg_code_ref determine their data types through internal rules.
For example, in the Gain block dialog box, on the Parameter Attributes tab, Parameter data
type is set to Inherit: Inherit via internal rule (the default). In this case, the internal
rule chooses the same data type as the input and output signals, single.

2 The model arguments in the model workspace use context-sensitive data typing because the
value of the DataType property is set to auto (the default). With this setting, the model
arguments use the same data type as the block parameters, single.

3 The formal parameters in the generated code use the same data type as the model arguments,
single.

Generate Tunable Argument Values

You can configure the instance-specific values in the Model blocks to appear in the generated code as
tunable global variables. This technique enables you to store the parameter values for each instance
in memory and to tune the values during code execution.

In the top model ex_arg_code, select the Model Data Editor Parameters tab.

Use the Model Data Editor to set the values of the model arguments according to this figure.

set_param('ex_arg_code/Model','ParameterArgumentValues',...
    struct('coeffArg','coeffForInst1','gainArg','gainForInst1'))
set_param('ex_arg_code/Model1','ParameterArgumentValues',...
    struct('coeffArg','coeffForInst2','gainArg','gainForInst2'))

View the contents of the ex_arg_code_ref model workspace in Model Explorer.
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Copy gainArg and coeffArg from the ex_arg_code_ref model workspace to the base workspace.

Rename gainArg as gainForInst1. Rename coeffArg as coeffForInst1.

gainForInst1 = getVariable(modelWorkspace,'gainArg');
gainForInst1 = copy(gainForInst1);
coeffForInst1 = getVariable(modelWorkspace,'coeffArg');
coeffForInst1 = copy(coeffForInst1);

Copy gainForInst1 and coeffForInst1 as gainForInst2 and coeffForInst2.

gainForInst2 = copy(gainForInst1);
coeffForInst2 = copy(coeffForInst1);

Set the instance-specific parameter values by using the Value property of the parameter objects in
the base workspace.

gainForInst1.Value = 2.98;
coeffForInst1.Value = 0.98;

gainForInst2.Value = 3.34;
coeffForInst2.Value = 1.11;

For each new parameter object, on the Code Generation tab, set StorageClass to
ExportedGlobal. This setting causes the parameter objects to appear in the generated code as
tunable global variables.

gainForInst1.StorageClass = 'ExportedGlobal';
coeffForInst1.StorageClass = 'ExportedGlobal';
gainForInst2.StorageClass = 'ExportedGlobal';
coeffForInst2.StorageClass = 'ExportedGlobal';

Generate code from the top model.

slbuild('ex_arg_code')

### Starting serial model reference code generation build
### Model reference code generation target for ex_arg_code_ref is up to date.
### Starting build procedure for: ex_arg_code
### Successful completion of build procedure for: ex_arg_code

Build Summary

Top model targets built:

Model        Action                       Rebuild Reason                   
===========================================================================
ex_arg_code  Code generated and compiled  Generated code was out of date.  

1 of 2 models built (1 models already up to date)
Build duration: 0h 0m 15.754s

The file ex_arg_code.c defines the global variables that correspond to the parameter objects in the
base workspace.

file = fullfile('ex_arg_code_grt_rtw','ex_arg_code.c');
rtwdemodbtype(file,'/* Exported block parameters */',...
    '/* Block states (default storage) */',1,0)
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/* Exported block parameters */
real32_T coeffForInst1 = 0.98F;        /* Variable: coeffForInst1
                                        * Referenced by: '<Root>/Model'
                                        */
real32_T coeffForInst2 = 1.11F;        /* Variable: coeffForInst2
                                        * Referenced by: '<Root>/Model1'
                                        */
real32_T gainForInst1 = 2.98F;         /* Variable: gainForInst1
                                        * Referenced by: '<Root>/Model'
                                        */
real32_T gainForInst2 = 3.34F;         /* Variable: gainForInst2
                                        * Referenced by: '<Root>/Model1'
                                        */

In each call to ex_arg_code_ref, the top model algorithm uses the global variables to set the values
of the formal parameters.

rtwdemodbtype(file,'/* ModelReference: ''<Root>/Model'' incorporates:',...
    'gainForInst2);',1,1)

  /* ModelReference: '<Root>/Model' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out1'
   */
  ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out1, coeffForInst1,
                  gainForInst1, &(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* ModelReference: '<Root>/Model1' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out2'
   */
  ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out2, coeffForInst2,
                  gainForInst2, &(ex_arg_code_DW.Model1_InstanceData.rtdw));

  /* Matfile logging */
  rt_UpdateTXYLogVars(ex_arg_code_M->rtwLogInfo,
                      (&ex_arg_code_M->Timing.taskTime0));

  /* signal main to stop simulation */
  {                                    /* Sample time: [0.2s, 0.0s] */
    if ((rtmGetTFinal(ex_arg_code_M)!=-1) &&
        !((rtmGetTFinal(ex_arg_code_M)-ex_arg_code_M->Timing.taskTime0) >
          ex_arg_code_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(ex_arg_code_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
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  if (!(++ex_arg_code_M->Timing.clockTick0)) {
    ++ex_arg_code_M->Timing.clockTickH0;
  }

  ex_arg_code_M->Timing.taskTime0 = ex_arg_code_M->Timing.clockTick0 *
    ex_arg_code_M->Timing.stepSize0 + ex_arg_code_M->Timing.clockTickH0 *
    ex_arg_code_M->Timing.stepSize0 * 4294967296.0;
}

/* Model initialize function */
void ex_arg_code_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)ex_arg_code_M, 0,
                sizeof(RT_MODEL_ex_arg_code_T));
  rtmSetTFinal(ex_arg_code_M, 10.0);
  ex_arg_code_M->Timing.stepSize0 = 0.2;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    ex_arg_code_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(ex_arg_code_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(ex_arg_code_M->rtwLogInfo, (NULL));
    rtliSetLogT(ex_arg_code_M->rtwLogInfo, "tout");
    rtliSetLogX(ex_arg_code_M->rtwLogInfo, "");
    rtliSetLogXFinal(ex_arg_code_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(ex_arg_code_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(ex_arg_code_M->rtwLogInfo, 0);
    rtliSetLogMaxRows(ex_arg_code_M->rtwLogInfo, 0);
    rtliSetLogDecimation(ex_arg_code_M->rtwLogInfo, 1);

    /*
     * Set pointers to the data and signal info for each output
     */
    {
      static void * rt_LoggedOutputSignalPtrs[] = {
        &ex_arg_code_Y.Out1,
        &ex_arg_code_Y.Out2
      };

      rtliSetLogYSignalPtrs(ex_arg_code_M->rtwLogInfo, ((LogSignalPtrsType)
        rt_LoggedOutputSignalPtrs));
    }

    {
      static int_T rt_LoggedOutputWidths[] = {
        1,
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        1
      };

      static int_T rt_LoggedOutputNumDimensions[] = {
        1,
        1
      };

      static int_T rt_LoggedOutputDimensions[] = {
        1,
        1
      };

      static boolean_T rt_LoggedOutputIsVarDims[] = {
        0,
        0
      };

      static void* rt_LoggedCurrentSignalDimensions[] = {
        (NULL),
        (NULL)
      };

      static int_T rt_LoggedCurrentSignalDimensionsSize[] = {
        4,
        4
      };

      static BuiltInDTypeId rt_LoggedOutputDataTypeIds[] = {
        SS_SINGLE,
        SS_SINGLE
      };

      static int_T rt_LoggedOutputComplexSignals[] = {
        0,
        0
      };

      static RTWPreprocessingFcnPtr rt_LoggingPreprocessingFcnPtrs[] = {
        (NULL),
        (NULL)
      };

      static const char_T *rt_LoggedOutputLabels[] = {
        "",
        "" };

      static const char_T *rt_LoggedOutputBlockNames[] = {
        "ex_arg_code/Out1",
        "ex_arg_code/Out2" };

      static RTWLogDataTypeConvert rt_RTWLogDataTypeConvert[] = {
        { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 },

        { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 }
      };

      static RTWLogSignalInfo rt_LoggedOutputSignalInfo[] = {
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        {
          2,
          rt_LoggedOutputWidths,
          rt_LoggedOutputNumDimensions,
          rt_LoggedOutputDimensions,
          rt_LoggedOutputIsVarDims,
          rt_LoggedCurrentSignalDimensions,
          rt_LoggedCurrentSignalDimensionsSize,
          rt_LoggedOutputDataTypeIds,
          rt_LoggedOutputComplexSignals,
          (NULL),
          rt_LoggingPreprocessingFcnPtrs,

          { rt_LoggedOutputLabels },
          (NULL),
          (NULL),
          (NULL),

          { rt_LoggedOutputBlockNames },

          { (NULL) },
          (NULL),
          rt_RTWLogDataTypeConvert
        }
      };

      rtliSetLogYSignalInfo(ex_arg_code_M->rtwLogInfo, rt_LoggedOutputSignalInfo);

      /* set currSigDims field */
      rt_LoggedCurrentSignalDimensions[0] = &rt_LoggedOutputWidths[0];
      rt_LoggedCurrentSignalDimensions[1] = &rt_LoggedOutputWidths[1];
    }

    rtliSetLogY(ex_arg_code_M->rtwLogInfo, "yout");
  }

  /* states (dwork) */
  (void) memset((void *)&ex_arg_code_DW, 0,
                sizeof(DW_ex_arg_code_T));

  /* external inputs */
  ex_arg_code_U.In1 = 0.0F;

  /* external outputs */
  (void) memset((void *)&ex_arg_code_Y, 0,
                sizeof(ExtY_ex_arg_code_T));

  /* Model Initialize function for ModelReference Block: '<Root>/Model' */
  ex_arg_code_ref_initialize(rtmGetErrorStatusPointer(ex_arg_code_M),
    &(ex_arg_code_DW.Model_InstanceData.rtm),
    &(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* Model Initialize function for ModelReference Block: '<Root>/Model1' */
  ex_arg_code_ref_initialize(rtmGetErrorStatusPointer(ex_arg_code_M),
    &(ex_arg_code_DW.Model1_InstanceData.rtm),
    &(ex_arg_code_DW.Model1_InstanceData.rtdw));

  /* Matfile logging */
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  rt_StartDataLoggingWithStartTime(ex_arg_code_M->rtwLogInfo, 0.0, rtmGetTFinal
    (ex_arg_code_M), ex_arg_code_M->Timing.stepSize0, (&rtmGetErrorStatus
    (ex_arg_code_M)));

  /* SystemInitialize for ModelReference: '<Root>/Model' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out1'
   */
  ex_arg_code_ref_Init(&(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* SystemInitialize for ModelReference: '<Root>/Model1' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out2'
   */
  ex_arg_code_ref_Init(&(ex_arg_code_DW.Model1_InstanceData.rtdw));
}

/* Model terminate function */
void ex_arg_code_terminate(void)
{
  /* (no terminate code required) */
}

The global variables in the generated code use the data type real32_T (single) because:

1 The parameter objects in the base workspace use context-sensitive data typing because the
DataType property is set to auto (the default). With this setting, the parameter objects in the
base workspace use the same data type as the model arguments, single.

2 The global variables in the generated code use the same data type as the parameter objects in
the base workspace.

Group Multiple Model Arguments into Single Structure

Use the Model Explorer to copy gainArg and coeffArg from the ex_arg_code_ref model
workspace into the base workspace.

temp = getVariable(modelWorkspace,'gainArg');
gainArg = copy(temp);
temp = getVariable(modelWorkspace,'coeffArg');
coeffArg = copy(temp);

At the command prompt, combine these two parameter objects into a structure, structArg.

structArg = Simulink.Parameter(struct('gain',gainArg.Value,...
    'coeff',coeffArg.Value));

Use the Model Explorer to move structArg into the model workspace.

assignin(modelWorkspace,'structArg',copy(structArg));
clear structArg gainArg coeffArg

In the Contents pane, configure structArg as the only model argument.

set_param('ex_arg_code_ref','ParameterArgumentNames','structArg')

5 Referenced Models in Simulink Coder

5-42



In the ex_arg_code_ref model, select the Model Data Editor Parameters tab.

Use the Model Data Editor to set the value of the Gain parameter to structArg.gain and the value
of the Numerator parameter to structArg.coeff. Save the model.

set_param('ex_arg_code_ref/Gain','Gain','structArg.gain')
set_param('ex_arg_code_ref/Discrete Filter',...
    'Numerator','structArg.coeff')
save_system('ex_arg_code_ref')

At the command prompt, combine the four parameter objects in the base workspace into two
structures. Each structure stores the parameter values for one instance of ex_arg_code_ref.

structForInst1 = Simulink.Parameter(struct('gain',gainForInst1.Value,...
    'coeff',coeffForInst1.Value));

structForInst2 = Simulink.Parameter(struct('gain',gainForInst2.Value,...
    'coeff',coeffForInst2.Value));

In the top model ex_arg_code, use the Model Data Editor to set the argument values according to this
figure.

set_param('ex_arg_code/Model','ParameterArgumentValues',...
    struct('structArg','structForInst1'))
set_param('ex_arg_code/Model1','ParameterArgumentValues',...
    struct('structArg','structForInst2'))

Click the Show/refresh additional information button.

For the new parameter objects structForInst1 and structForInst2, use the Model Explorer to
apply the storage class ExportedGlobal.

structForInst1.StorageClass = 'ExportedGlobal';
structForInst2.StorageClass = 'ExportedGlobal';
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At the command prompt, use the function Simulink.Bus.createObject to create a
Simulink.Bus object. The hierarchy of elements in the object matches the hierarchy of the
structure fields. The default name of the object is slBus1.

Simulink.Bus.createObject(structForInst1.Value);

Rename the bus object as myParamStructType by copying it.

myParamStructType = copy(slBus1);

In the Model Data Editor for ex_arg_code, use the Data Type column to set the data type of
structForInst1 and structForInst2 to Bus: myParamStructType.

structForInst1.DataType = 'Bus: myParamStructType';
structForInst2.DataType = 'Bus: myParamStructType';

temp = getVariable(modelWorkspace,'structArg');
temp = copy(temp);
temp.DataType = 'Bus: myParamStructType';
assignin(modelWorkspace,'structArg',copy(temp));

Save the ex_arg_code_ref model.

save_system('ex_arg_code_ref')

When you use structures to group parameter values, you cannot take advantage of context-sensitive
data typing to control the data types of the fields of the structures (for example, the fields of
structForInst1). However, you can use the properties of the bus object to control the field data
types.

At the command promt, set the data type of the elements in the bus object to single. The
corresponding fields in the structures (such as structForInst1 and structArg) use the same data
type.

myParamStructType.Elements(1).DataType = 'single';
myParamStructType.Elements(2).DataType = 'single';

Generate code from the top model, ex_arg_code.

slbuild('ex_arg_code')

### Starting serial model reference code generation build
### Successfully updated the model reference code generation target for: ex_arg_code_ref
### Starting build procedure for: ex_arg_code
### Successful completion of build procedure for: ex_arg_code

Build Summary

Code generation targets built:

Model            Action                       Rebuild Reason                                 
=============================================================================================
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ex_arg_code_ref  Code generated and compiled  Model or library ex_arg_code_ref has changed.  

Top model targets built:

Model        Action                       Rebuild Reason                   
===========================================================================
ex_arg_code  Code generated and compiled  Referenced models were updated.  

2 of 2 models built (0 models already up to date)
Build duration: 0h 0m 23.492s

The file ex_arg_code_types.h defines the structure type myParamStructType, which
corresponds to the Simulink.Bus object.

file = fullfile('ex_arg_code_grt_rtw','ex_arg_code_types.h');
rtwdemodbtype(file,'typedef struct {','} myParamStructType;',1,1)

typedef struct {
  real32_T gain;
  real32_T coeff;
} myParamStructType;

In the file ex_arg_code_ref.c, the referenced model entry-point function has a formal parameter,
rtp_structArg, that correspond to the model argument structArg.

file = fullfile('slprj','grt','ex_arg_code_ref','ex_arg_code_ref.c');
rtwdemodbtype(file,'/* Output and update for referenced model:',...
    '*rtp_structArg)',1,1)

/* Output and update for referenced model: 'ex_arg_code_ref' */
void ex_arg_code_ref(const real32_T *rtu_In1, real32_T *rty_Out1, const
                     myParamStructType *rtp_structArg, DW_ex_arg_code_ref_f_T
                     *localDW)
{
  real32_T rtb_Sum;

  /* Sum: '<Root>/Sum' incorporates:
   *  UnitDelay: '<Root>/Unit Delay'
   */
  rtb_Sum = *rtu_In1 + localDW->UnitDelay_DSTATE;

  /* Gain: '<Root>/Gain' */
  rtb_Sum *= rtp_structArg->gain;

  /* DiscreteFilter: '<Root>/Discrete Filter' */
  localDW->DiscreteFilter_tmp = rtb_Sum - 0.5F * localDW->DiscreteFilter_states;
  *rty_Out1 = rtp_structArg->coeff * localDW->DiscreteFilter_tmp;

  /* Update for UnitDelay: '<Root>/Unit Delay' */
  localDW->UnitDelay_DSTATE = rtb_Sum;

  /* Update for DiscreteFilter: '<Root>/Discrete Filter' */
  localDW->DiscreteFilter_states = localDW->DiscreteFilter_tmp;
}

/* Model initialize function */
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void ex_arg_code_ref_initialize(const char_T **rt_errorStatus,
  RT_MODEL_ex_arg_code_ref_T *const ex_arg_code_ref_M, DW_ex_arg_code_ref_f_T
  *localDW)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatusPointer(ex_arg_code_ref_M, rt_errorStatus);

  /* states (dwork) */
  (void) memset((void *)localDW, 0,
                sizeof(DW_ex_arg_code_ref_f_T));
}

The file ex_arg_code.c defines the global structure variables that correspond to the parameter
objects in the base workspace.

file = fullfile('ex_arg_code_grt_rtw','ex_arg_code.c');
rtwdemodbtype(file,'/* Exported block parameters */',...
    '/* Block states (default storage) */',1,0)

/* Exported block parameters */
myParamStructType structForInst1 = {
  2.98F,
  0.98F
} ;                                    /* Variable: structForInst1
                                        * Referenced by: '<Root>/Model'
                                        */

myParamStructType structForInst2 = {
  3.34F,
  1.11F
} ;                                    /* Variable: structForInst2
                                        * Referenced by: '<Root>/Model1'
                                        */

The top model algorithm in the file ex_arg_code.c passes the addresses of the structure variables
to the referenced model entry-point function.

file = fullfile('ex_arg_code_grt_rtw','ex_arg_code.c');
rtwdemodbtype(file,'/* ModelReference: ''<Root>/Model'' incorporates:',...
    '&structForInst2);',1,1)

  /* ModelReference: '<Root>/Model' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out1'
   */
  ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out1, &structForInst1,
                  &(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* ModelReference: '<Root>/Model1' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out2'
   */
  ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out2, &structForInst2,
                  &(ex_arg_code_DW.Model1_InstanceData.rtdw));
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  /* Matfile logging */
  rt_UpdateTXYLogVars(ex_arg_code_M->rtwLogInfo,
                      (&ex_arg_code_M->Timing.taskTime0));

  /* signal main to stop simulation */
  {                                    /* Sample time: [0.2s, 0.0s] */
    if ((rtmGetTFinal(ex_arg_code_M)!=-1) &&
        !((rtmGetTFinal(ex_arg_code_M)-ex_arg_code_M->Timing.taskTime0) >
          ex_arg_code_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(ex_arg_code_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
  if (!(++ex_arg_code_M->Timing.clockTick0)) {
    ++ex_arg_code_M->Timing.clockTickH0;
  }

  ex_arg_code_M->Timing.taskTime0 = ex_arg_code_M->Timing.clockTick0 *
    ex_arg_code_M->Timing.stepSize0 + ex_arg_code_M->Timing.clockTickH0 *
    ex_arg_code_M->Timing.stepSize0 * 4294967296.0;
}

/* Model initialize function */
void ex_arg_code_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)ex_arg_code_M, 0,
                sizeof(RT_MODEL_ex_arg_code_T));
  rtmSetTFinal(ex_arg_code_M, 10.0);
  ex_arg_code_M->Timing.stepSize0 = 0.2;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    ex_arg_code_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(ex_arg_code_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(ex_arg_code_M->rtwLogInfo, (NULL));
    rtliSetLogT(ex_arg_code_M->rtwLogInfo, "tout");
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    rtliSetLogX(ex_arg_code_M->rtwLogInfo, "");
    rtliSetLogXFinal(ex_arg_code_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(ex_arg_code_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(ex_arg_code_M->rtwLogInfo, 0);
    rtliSetLogMaxRows(ex_arg_code_M->rtwLogInfo, 0);
    rtliSetLogDecimation(ex_arg_code_M->rtwLogInfo, 1);

    /*
     * Set pointers to the data and signal info for each output
     */
    {
      static void * rt_LoggedOutputSignalPtrs[] = {
        &ex_arg_code_Y.Out1,
        &ex_arg_code_Y.Out2
      };

      rtliSetLogYSignalPtrs(ex_arg_code_M->rtwLogInfo, ((LogSignalPtrsType)
        rt_LoggedOutputSignalPtrs));
    }

    {
      static int_T rt_LoggedOutputWidths[] = {
        1,
        1
      };

      static int_T rt_LoggedOutputNumDimensions[] = {
        1,
        1
      };

      static int_T rt_LoggedOutputDimensions[] = {
        1,
        1
      };

      static boolean_T rt_LoggedOutputIsVarDims[] = {
        0,
        0
      };

      static void* rt_LoggedCurrentSignalDimensions[] = {
        (NULL),
        (NULL)
      };

      static int_T rt_LoggedCurrentSignalDimensionsSize[] = {
        4,
        4
      };

      static BuiltInDTypeId rt_LoggedOutputDataTypeIds[] = {
        SS_SINGLE,
        SS_SINGLE
      };

      static int_T rt_LoggedOutputComplexSignals[] = {
        0,
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        0
      };

      static RTWPreprocessingFcnPtr rt_LoggingPreprocessingFcnPtrs[] = {
        (NULL),
        (NULL)
      };

      static const char_T *rt_LoggedOutputLabels[] = {
        "",
        "" };

      static const char_T *rt_LoggedOutputBlockNames[] = {
        "ex_arg_code/Out1",
        "ex_arg_code/Out2" };

      static RTWLogDataTypeConvert rt_RTWLogDataTypeConvert[] = {
        { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 },

        { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 }
      };

      static RTWLogSignalInfo rt_LoggedOutputSignalInfo[] = {
        {
          2,
          rt_LoggedOutputWidths,
          rt_LoggedOutputNumDimensions,
          rt_LoggedOutputDimensions,
          rt_LoggedOutputIsVarDims,
          rt_LoggedCurrentSignalDimensions,
          rt_LoggedCurrentSignalDimensionsSize,
          rt_LoggedOutputDataTypeIds,
          rt_LoggedOutputComplexSignals,
          (NULL),
          rt_LoggingPreprocessingFcnPtrs,

          { rt_LoggedOutputLabels },
          (NULL),
          (NULL),
          (NULL),

          { rt_LoggedOutputBlockNames },

          { (NULL) },
          (NULL),
          rt_RTWLogDataTypeConvert
        }
      };

      rtliSetLogYSignalInfo(ex_arg_code_M->rtwLogInfo, rt_LoggedOutputSignalInfo);

      /* set currSigDims field */
      rt_LoggedCurrentSignalDimensions[0] = &rt_LoggedOutputWidths[0];
      rt_LoggedCurrentSignalDimensions[1] = &rt_LoggedOutputWidths[1];
    }

    rtliSetLogY(ex_arg_code_M->rtwLogInfo, "yout");
  }
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  /* states (dwork) */
  (void) memset((void *)&ex_arg_code_DW, 0,
                sizeof(DW_ex_arg_code_T));

  /* external inputs */
  ex_arg_code_U.In1 = 0.0F;

  /* external outputs */
  (void) memset((void *)&ex_arg_code_Y, 0,
                sizeof(ExtY_ex_arg_code_T));

  /* Model Initialize function for ModelReference Block: '<Root>/Model' */
  ex_arg_code_ref_initialize(rtmGetErrorStatusPointer(ex_arg_code_M),
    &(ex_arg_code_DW.Model_InstanceData.rtm),
    &(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* Model Initialize function for ModelReference Block: '<Root>/Model1' */
  ex_arg_code_ref_initialize(rtmGetErrorStatusPointer(ex_arg_code_M),
    &(ex_arg_code_DW.Model1_InstanceData.rtm),
    &(ex_arg_code_DW.Model1_InstanceData.rtdw));

  /* Matfile logging */
  rt_StartDataLoggingWithStartTime(ex_arg_code_M->rtwLogInfo, 0.0, rtmGetTFinal
    (ex_arg_code_M), ex_arg_code_M->Timing.stepSize0, (&rtmGetErrorStatus
    (ex_arg_code_M)));

  /* SystemInitialize for ModelReference: '<Root>/Model' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out1'
   */
  ex_arg_code_ref_Init(&(ex_arg_code_DW.Model_InstanceData.rtdw));

  /* SystemInitialize for ModelReference: '<Root>/Model1' incorporates:
   *  Inport: '<Root>/In1'
   *  Outport: '<Root>/Out2'
   */
  ex_arg_code_ref_Init(&(ex_arg_code_DW.Model1_InstanceData.rtdw));
}

/* Model terminate function */
void ex_arg_code_terminate(void)
{
  /* (no terminate code required) */
}

Control Data Types of Model Arguments and Argument Values
When you use model arguments, you can apply a data type to:

• The block parameters that use the arguments (for certain blocks, such as those in the Discrete
library).

• The arguments in the referenced model workspace.
• The argument values that you specify in Model blocks.
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To generate efficient code by eliminating unnecessary typecasts and C shifts, consider using inherited
and context-sensitive data typing to match the data types.

• In the model workspace, use a MATLAB variable whose data type is double or a parameter object
whose DataType property is set to auto. In this case, the variable or object uses the same data
type as the block parameter.

• When you set the argument values in Model blocks, take advantage of context-sensitive data
typing. To set an argument value, use an untyped value.

• A literal number such as 15.23. Do not use a typed expression such as single(15.23).
• A MATLAB variable whose data type is double.
• A Simulink.Parameter object whose DataType property is set to auto.

In these cases, the number, variable, or object uses the same data type as the model argument in
the referenced model workspace. If you also configure the model argument to use context-
sensitive data typing, you can control the data types of the block parameter, the argument, and
the argument value by specifying the type only for the block parameter.

For basic information about controlling parameter data types, see “Parameter Data Types in the
Generated Code” on page 34-129.

Use Model Argument in Different Data Type Contexts

If you use a model argument to set multiple block parameter values, and the data types of the block
parameters differ, you cannot use context-sensitive data typing (double or auto) for the argument in
the model workspace. You must explicitly specify a data type for the argument. For example, if the
argument in the model workspace is a parameter object (such as Simulink.Parameter), set the
DataType property to a value other than auto. For more information about this situation, see “Reuse
Parameter Data in Different Data Type Contexts” on page 34-141.

In this case, you can continue to take advantage of context-sensitive data typing to control the data
type of the argument values that you specify in Model blocks. Each argument value uses the data type
that you specify for the corresponding argument in the model workspace.

See Also

Related Examples
• “Generate Code for Model Reference Hierarchy” on page 5-2
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Parameterize Instances of a Reusable Referenced Model”
• “Organize Data into Structures in Generated Code” on page 34-145
• “Parameter Data Types in the Generated Code” on page 34-129
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Combined Models in Simulink Coder

• “Combine Code Generated for Multiple Models” on page 6-2
• “Function Reuse in Generated Code” on page 6-5
• “File Packaging for Models (Code and Data)” on page 6-10
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Combine Code Generated for Multiple Models
To combine code, which the code generator produces for multiple models or multiple instances of a
model, into one executable program, use these techniques:

• Model reference hierarchy. See “Model Reference Basics” and “Generate Code for Model
Reference Hierarchy”.

• If you have Embedded Coder software, interface the code for multiple models to a common
harness program. From the harness program, call the entry-point functions generated for each
model. The ert.tlc system target file has restrictions, related to embedded processing that
might be incompatible with your application.

• Generate reusable, multi-instance code that is reentrant. See “Combine Code Generated for
Multiple Models or Multiple Instances of a Model” on page 6-3.

Note The S-function system target (rtwsfcn.tlc) does not support combining code generated for
multiple models.

To combine models for simulation and code generation, consider using model referencing. Model
referencing helps with:

• Symbol naming consistency
• Required scheduling of the overall algorithm
• Model configuration consistency

Considerations for Combining Code for Different Models
If you combine code generated for different models that is, without using referenced models, consider
the following:

• Data is global. Symbol (name) clashes can result.
• Configuration parameter settings for the models must match, including settings such as hardware

word sizes.
• Reuse and sharing of code can be suboptimal (for example, duplicate code for shared utility

functions, scheduling, and solvers).
• Scheduling can be more complex (for example, models can have periodic sample times that are

not multiples of each other, making scheduling from a common timer interrupt more complicated)
• For plant models that use continuous time and state, the continuous time signals connecting

models are not handled by a single solver like continuous time signals within a model, which can
lead to subtle, numeric differences.

Share Data Across Models

Use unidirectional signal connections between models. These connections affect the order in which
models are called. For example, if you use an output signal from modelA as input to modelB, the
modelA output computation is called first.

Timing Issues

When combining code generated for multiple models or multiple instances of a model:
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• Configure the models by using the same solver mode (single-tasking or multitasking).
• If the models use continuous states, configure the models by using the same solver.

If the base rates for the models differ, the main program (such as rt_malloc_main.c) must set up
the timer interrupt to occur at the greatest common divisor rate of the models. The main program
calls each model at a time interval.

Data Logging and External Mode Support

A multiple-model program can log data to separate MAT-files for each model.

Only one of the models in a multiple-model program can use external mode.

Control Ownership of Data
If you have Embedded Coder software, you can specify an owner for individual data items such as
signals, parameters, and states. The owner of a data item generates the definition, the memory
allocation and initialization, for the data item. For example, if you apply a storage class to a
Simulink.Signal object so that it appears as a global variable in the generated code, specify one of
the combined models as the owner of the object. The code generated for that model defines the
variable.

If you use model referencing, you can modularize the generated code and establish clear ownership
of data when you work in a team.

If you do not use model referencing, you can prevent generation of duplicate definitions for a data
item. For example, suppose you store a Simulink.Parameter object in the base workspace and
apply the storage class ExportedGlobal. If you generate code from two separate models that use
the object, each model generates a definition for the corresponding global variable. Instead, you can
specify an owner for the object so that only the owner generates a definition.

To specify an owner for a data item:

1 Apply a storage class to the data item. See “Organize Parameter Data into a Structure by Using
Struct Storage Class” on page 33-68.

2 Configure the owner of the data item by specifying a value for the Owner property.
3 Select the model configuration parameter Use owner from data object for data definition

placement.

For more information about controlling ownership and file placement of data definitions and
declarations, see “Control Placement of Global Data Definitions and Declarations in Generated Files”
on page 35-2.

Combine Code Generated for Multiple Models or Multiple Instances of
a Model
For each model that you are combining code for, generate the code.

1 Set the system target file to a GRT- or ERT-based system target file. The system target file for the
models that you combine must be the same.

2 If you intend to have multiple instances of that model in the application, set the model
configuration parameter Code interface packaging to Reusable function. If you specified
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an ERT-based system target file, optionally, you can set the model configuration parameter Use
dynamic memory allocation for model initialization, depending on whether you want to
statically or dynamically allocate the memory for each instance of the model.

3 Generate source code. The code generator includes an allocation function in the generated file
model.c. The allocation function dynamically allocates model data for each instance of the
model.

After generating source code for each model:

1 Compile the code for each model that you are combining.
2 Combine the makefiles generated for the models into one makefile.
3 Create a combined simulation engine by modifying a main program, such as

rt_malloc_main.c. The main program initializes and calls the code generated for each model.
4 Run the makefile. The makefile links the object files and the main program to an executable

program.

See Also

Related Examples
• “Generate Code for Model Reference Hierarchy” on page 5-2
• “Generate Reusable Code from Model Reference Hierarchy” on page 5-17
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Function Reuse in Generated Code
This example shows how to configure an atomic subsystem for generating reusable code. To specify
that the code generated for a subsystem execute as an atomic unit, on the Block Parameters dialog
box, select the Treat as atomic unit parameter . That parameter enables the Function Packaging
parameter on the Code Generation tab. The Function Packaging parameter has these four
settings:

• Inline: Inline the subsystem code
• Nonreusable function: Function with I/O passed as global data
• Reusable function: Function with I/O passed as function arguments
• Auto: Let Simulink Coder optimize based on context

The Reusable function and Auto settings permit the code generator to reuse subsystem code.
The Reusable function and Nonreusable function settings enable the Function name
options, Function name, and File name options parameters.

If you have an Embedded Coder license, you can configure a nonreusable subsystem to accept
arguments.

Example Model

The rtwdemo_ssreuse model contains two identical subsystems, SS1 and SS2. For these
subsystems, the Function packaging parameter is set to Reusable function, and the Function
name parameter is myfun. The subsystems are parameterized masked subsystems. To see the
contents of the masked subsystems, right-click the subsystem blocks and select Mask > Look Under
Mask.

model = 'rtwdemo_ssreuse';
open_system(model);
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Generate and Inspect Code

Create a temporary folder for the build and inspection process. Open the Simulink Coder or
Embedded Coder app. Then, generate and inspect the code.

currentDir=pwd;
[~,cgDir]=rtwdemodir();
slbuild(model)

### Starting build procedure for: rtwdemo_ssreuse
### Successful completion of build procedure for: rtwdemo_ssreuse

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                                    
================================================================================================
rtwdemo_ssreuse  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.359s

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_ssreuse_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */

  /* Inport: '<Root>/In1' incorporates:
   *  Inport: '<Root>/In2'
   */
  myfun(rtwdemo_ssreuse_U.In1, rtwdemo_ssreuse_U.In2, rtwdemo_ssreuse_P.T1Data,
        rtwdemo_ssreuse_P.T1Break, &rtwdemo_ssreuse_B.SS1);

  /* End of Outputs for SubSystem: '<Root>/SS1' */

  /* Outport: '<Root>/Out1' */
  rtwdemo_ssreuse_Y.Out1 = rtwdemo_ssreuse_B.SS1.LookupTable;

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */

  /* Inport: '<Root>/In1' incorporates:
   *  Inport: '<Root>/In2'
   */
  myfun(rtwdemo_ssreuse_U.In1, rtwdemo_ssreuse_U.In2, rtwdemo_ssreuse_P.T2Data,
        rtwdemo_ssreuse_P.T2Break, &rtwdemo_ssreuse_B.SS2);

  /* End of Outputs for SubSystem: '<Root>/SS2' */

  /* Outport: '<Root>/Out2' */
  rtwdemo_ssreuse_Y.Out2 = rtwdemo_ssreuse_B.SS2.LookupTable;
}

In the model step function, there are two calls to the reusable function, myfun. The mask parameters,
T1Break, T1Data, T2Break, and T2Data, are function arguments.
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Change the Function Packaging parameter to Inline.

set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Inline')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Inline')

Generate and inspect the code.

slbuild(model)

### Starting build procedure for: rtwdemo_ssreuse
### Successful completion of build procedure for: rtwdemo_ssreuse

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                   
===============================================================================
rtwdemo_ssreuse  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.345s

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_ssreuse_step(void)
{
  real_T Out1_tmp;

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */
  /* Sum: '<S1>/Sum' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Sum: '<S2>/Sum'
   */
  Out1_tmp = rtwdemo_ssreuse_U.In1 + rtwdemo_ssreuse_U.In2;

  /* End of Outputs for SubSystem: '<Root>/SS2' */

  /* Outport: '<Root>/Out1' incorporates:
   *  Lookup_n-D: '<S1>/Lookup Table'
   *  Sum: '<S1>/Sum'
   */
  rtwdemo_ssreuse_Y.Out1 = look1_binlx(Out1_tmp, rtwdemo_ssreuse_P.T1Break,
    rtwdemo_ssreuse_P.T1Data, 10U);

  /* End of Outputs for SubSystem: '<Root>/SS1' */

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  /* Outport: '<Root>/Out2' incorporates:
   *  Lookup_n-D: '<S2>/Lookup Table'
   */
  rtwdemo_ssreuse_Y.Out2 = look1_binlx(Out1_tmp, rtwdemo_ssreuse_P.T2Break,
    rtwdemo_ssreuse_P.T2Data, 10U);
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  /* End of Outputs for SubSystem: '<Root>/SS2' */
}

In the model step function, the subsystem code is inlined.

Change the Function Packaging parameter to Nonreusable function. For SS2 , change the
Function name parameter to myfun2.

set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Nonreusable function')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Nonreusable function')
set_param('rtwdemo_ssreuse/SS2','RTWFcnName','myfun2')

Generate and inspect the code.

slbuild(model)

### Starting build procedure for: rtwdemo_ssreuse
### Successful completion of build procedure for: rtwdemo_ssreuse

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                   
===============================================================================
rtwdemo_ssreuse  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.098s

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_ssreuse_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */
  myfun();

  /* End of Outputs for SubSystem: '<Root>/SS1' */

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  myfun2();

  /* End of Outputs for SubSystem: '<Root>/SS2' */
}

The model step function contains calls to the functions myfun and myfun2. These functions have a
void-void interface.

Change the Function Packaging parameter to Auto.

set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Auto')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Auto')

For the auto setting, Simulink Coder chooses the optimal format. For this model, the optimal format
is a reusable function.
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Close the model and clean up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

 Function Reuse in Generated Code

6-9



File Packaging for Models (Code and Data)
This example shows how referenced models provide system interface encapsulation and incremental
code generation. You can reference one model from another model (one or more times), and aspects
of the referenced model are fixed: input/output signal types, parameter types, and sample times.
Therefore, you can modularize your design and perform incremental code generation.

The code generator partitions data and functions of a referenced model into its own set of files,
independent of its parent model. In this example, the referenced model rtwdemo_mdlrefbot is
referenced three times. For simulation and code generation, the model is incrementally generated,
which means rtwdemo_mdlrefbot builds the first time, but not on subsequent builds, unless you
change rtwdemo_mdlrefbot.

open_system('rtwdemo_mdlreftop')

1 Generate and inspect the code.
2 Change the value of one of the constant inputs in rtwdemo_mdlreftop.
3 Generate code. The code generator does not reproduce code for reference model

rtwdemo_mdlreftop.

bdclose('rtwdemo_mdlreftop');
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What Is Code Reuse?
Code reuse is a programming technique that reduces time and resources to develop software. When
you develop code for reuse, the code serves multiple purposes. The technique involves
modularization, which enables multiple individuals to develop code for various system components
independently and in parallel. The technique also simplifies software distribution.

A software library is an example of code reuse. A library can contain code for several functions, each
having specific behavior. To use a library, you need to know only the interface, which is the
specification for calling the library functions.

Reusable code can be reentrant. You can invoke, interrupt, and reinvoke reentrant code. Reentrant
code resides in shared memory. Instances of data associated with each use of the code are unique and
preserved. Multiple calls to a reusable, reentrant function, for example, can access the function code
with each call maintaining a unique data set.

Applications of code reuse include:

• Team-based development.
• Switching between implementations of a function.
• Intellectual property protection.
• Overriding library behavior with a custom implementation.
• Implementing a library that is based on standard library functions.
• Unit testing.
• Execution speed improvement.

The code generator supports code reuse and reentrancy. You can use key Simulink componentization
techniques to partition a model into design components that you simulate, generate code for, and
verify independently. You can save individual components as subsystems, libraries, referenced
models, or combinations of these elements from which you can generate code. For example, the code
generator produces reusable function code from library subsystems and export-function models.

See Also

More About
• “What Is Reentrant Code?” on page 7-3
• “Choose a Componentization Technique for Code Reuse” on page 7-4
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What Is Reentrant Code?
Reentrant (multi-instance) code is a reusable routine that multiple programs can invoke, interrupt,
and reinvoke simultaneously. When you want to reuse code, but associate each instance of the shared
code with unique, preserved data, use reentrant code. For example, consider this figure that shows
four instances of function sensor_read. Although the function algorithm is the same in each case,
the data associated with each instance varies and is relative to the sensor position.

To make generated code for a model component reentrant, you configure the component such that
model entry-point functions receive root-level input and output data as arguments. How you configure
the component depends on the modeling style or technique that you apply.

See Also

More About
• “What Is Code Reuse?” on page 7-2
• “Choose a Componentization Technique for Code Reuse” on page 7-4
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Choose a Componentization Technique for Code Reuse
Key componentization techniques that you can use with Simulink and the code generator to produce
reusable code include:

• Referenced models
• Subsystems
• Library subsystems
• Combinations of models, subsystems, and library subsystems

Choose componentization techniques based on your code reuse goals.

Goal Referenced
Model

Subsyste
m in
Model

Subsystem in Library

Design for explicit
code reuse.

√ √ √

Facilitate parallel
team development.

√ √ √

Reuse function within
a model or across
models.

√   

Reduce build time by
generating reusable
code incrementally.

√   

Verify reusable code
with SIL or PIL
simulation.

√   

Optimize generated
code by configuring
code generator to
detect opportunities
for code reuse.

√ √ √

Maximize reuse with
context-dependent
behavior.

 √ √

Develop a frequently
used, and infrequently
changed, utility
function.

  √

See Also

More About
• “Compare Capabilities of Model Components”
• “Generate Reentrant Code from Top Models” on page 7-18
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• “Generate Reentrant Code from Subsystems” on page 7-33
• “Generate Reentrant Code from Simulink Function Blocks” on page 7-23
• “Generate Reusable Code from Library Subsystems Shared Across Models” on page 7-41
• “Library-Based Code Generation for Reusable Library Subsystems” on page 8-2
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Simulink Function Blocks and Code Generation

Why Generate Code from Simulink Function Blocks and Function
Callers?
Simulink Function blocks provide a mechanism for generating C or C++ code for modeling
components that represent shared resources. You define the logic as a resource in a Simulink
Function block, which separates the function interface (name and arguments) from the
implementation of the logic. Function callers (Function Caller blocks, MATLAB Function blocks, and
Stateflow charts) can then reuse the function logic at different levels of the model hierarchy.

Simulink Function blocks provide an alternative to reusable subsystems. For example, a consideration
for using a Simulink Function block instead of a subsystem block is that a Simulink Function block
shares states between function callers. The code generator produces one function. If the Simulink
Function block contains blocks that have states, such as a delay or memory, the states persistent
between function callers. The order of the function calls is an important consideration.

Reusable functions that the code generator produces from subsystems do not share states. The code
generator produces one function for multiple instances of the subsystem as an optimization. If that
subsystem contains blocks that have states, the code generator produces one function, but passes a
different state variable to each instance. The instances do not share states.

Other uses of Simulink Function blocks and callers include:

• Nesting calls to a function.
• Calling a function defined in one modeling component from another modeling component.
• Generating functions that are globally accessible or scoped.
• Producing code for a client and server application.

Implementation Options
Choose how to implement Simulink functions and function callers based on your code generation
requirements. Considerations include:

• How you represent a function and function callers in a model
• Scope of a function
• Whether to export a function from a model (requires Embedded Coder)
• Function code interface customizations (requires Embedded Coder)
• Code generation requirements
• Code generation limitations

Choose a Modeling Pattern
This table shows C code for a function that multiplies an input value times two and a Simulink
Function block that can represent that function in a Simulink model.
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Function Definition Modeling Element
codegen-folder/subsystem.c

#include "timestwo_sf.h"

#include "ex_slfunc_comp_sf.h"
#include "ex_slfunc_comp_sf_private.h"

void timestwo_sf(real_T rtu_x, real_T *rty_y)
{
  *rty_y = 2.0 * rtu_x;
}

Simulink Function block

A Simulink function caller invokes a function defined with a Simulink Function block. From anywhere
in a model or chart hierarchy, you can call a function defined with a Simulink Function block by using
one of these modeling elements:

Function Call Modeling Element
codegen-folder/model.c

void ex_slfunc_comp_sf_step(void)
{
  real_T rtb_FunctionCaller1;

timestwo_sf(ex_slfunc_comp_sf_U.In1, &rtb_FunctionCaller1);

ex_slfunc_comp_sf_Y.Out1 = rtb_FunctionCaller1;
.
.
.

Function Caller block

codegen-folder/model.c

void ex_slfunc_comp_gf_step(void)
{
  real_T rtb_y1_l;

  timestwo_gf(ex_slfunc_comp_gf_U.In4, &rtb_y1_l);

  ex_slfunc_comp_gf_Y.Out4 = rtb_y1_l;  
  .
  .
  .

Stateflow chart transition

codegen-folder/model.c

void ex_slfunc_comp_mf_step(void)
{ 
  real_T rtb_y;
  
  timestwo_mf(ex_slfunc_comp_mf_U.In3, &rtb_y);

  ex_slfunc_comp_mf_Y.Out3 = rtb_y;
  .
  .
  .

MATLAB Function block
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For more information about modeling choices, see “Simulink Functions Overview”.

Specify Function Scope
A function that you define with a Simulink Function block can be global or scoped.

• Global---The code generator places code for a global function in source and header files that are
separate from model code files (for example, function.c and function.h) . The separate files
make the function code available for sharing between function callers.

• Scoped---The code generator places code for a scoped function in model code files (model.c and
model.h). To call a scoped function in the context of a model, the function caller must be at the
same level as the function in the model hierarchy, or one or more levels below.

To create a library of functions that are accessible from anywhere in the generated model code,
set up each function as a scoped Simulink Function block. Place each scoped function within a
virtual subsystem at the root level of a model.

For more information, see and “Scoped and Global Simulink Function Blocks Overview”.

Decide Whether to Generate Export Function Code
Although you can use Simulink Function blocks in a single top-model design, function code is more
reusable when you generate it as standalone, atomic components. You do that by designing the
functions in the context of export-function models.

For information, see “Generate Component Source Code for Export to External Code Base” on page
56-47 and “Export-Function Models Overview”.

Specify Function Code Interface Customizations
With Embedded Coder, simplify integration of generated code with external code by customizing
generated function code interfaces for Simulink Function and Function Caller blocks. You can
customize the function interfaces for:

• Global Simulink Function blocks
• Scoped Simulink Function blocks that are at the root level of a model

For more information, see “Configure Entry-Point Function Interfaces for Simulink Function and
Function Caller Blocks” on page 40-2.

Uncalled Simulink Function Blocks
If you use a Simulink Function block in a rate-based model and do not call that function, the code
generator treats the Simulink Function block as a constant and does not produce function code. For
example, this can occur during model development when you are ready to define a function, but are
not ready to identify a caller.

To identify such blocks in a rate-based model, display sample time colors during simulation. By
default, Constant blocks appear magenta. Because the code generator considers uncalled Simulink
Function blocks constants during simulation, they appear magenta.
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Requirements
• Within a model hierarchy, function names are unique. If the code generator finds multiple

functions with the same name, it issues an error. Change the name of one of the functions and
delete the slprj folder.

• The signature (for example, the arguments and argument data types) for a function and function
callers must match.

• If the code generator finds the function first and the signature of a function caller does not
match, the code generator issues an error. Change the function caller signature to match the
signature of the Simulink Function block or delete the slprj folder.

• If the code generator finds a function caller first and the signature of the function does not
match, the code generator issues a warning message. Change the signature of the function or
function caller so that the signatures match.

• In a Simulink Function block definition, do not define input and output signals for Argument
Inport and Argument Outport blocks with a storage class.

• Do not specify Argument Inport and Argument Outport blocks as test points.
• If you specify the data type of input and output signals for Argument Inport and Argument Outport

blocks as a Simulink.IntEnumType, Simulink.AliasType, or Simulink.Bus, set the
DataScope property to Imported or Exported.

• A function interface and function callers must agree in data type, complexity, dimension, and
number of arguments.

Limitations
• To generate code from a model that includes scoped Simulink functions, the model must be an

export-function model. The code generator does not support rate-based models that include
scoped Simulink functions.

• You can use a Simulink Function block to define a scoped function in a referenced model.
However, you cannot generate code for an export-function model that uses a Function Caller block
in an atomic subsystem to invoke that function.

• You can invoke a C++ function that the code generator produces from a Simulink Function block
with code generated from a Stateflow chart. Due to current scope limitations for generated C++
functions, you must invoke those functions with code generated from a Function Caller block.

• Simulink functions and function callers do not honor the MaxStackSize parameter.
• Code generation for a C++ class interface supports scoped Simulink functions only.

Generate and Call Reusable Function Code
This example shows how to use the Simulink Function and Function Caller blocks to generate
reusable function code. The code generator produces a global function, which complies with code
requirements so that existing external code can call the function and a local function. The code
generator also produces calls to global and local functions. The call to the global function shows that
the global function is reused (shared).

Code requirements for the global function are:

• Function names start with prefix func_.
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• Names of input arguments are of the form xn, where n is a unique integer value.
• Names of output arguments are of the form yn, where n is a unique integer value.
• Input and output arguments are integers (int) and are passed by reference. The native integer

size of the target hardware is 32 bits.

You create a function that calls the generated reusable function code. Then, you construct and
configure a model to match the code requirements.

Some of the features used in this example, such as data type aliasing and replacement, require
Embedded Coder software.

Inspect External Code That Calls Reusable Function

In your code generation root folder, create the files call_times2.h and call_times2.c. If you
prefer, you can copy the files from matlabroot\help\toolbox\ecoder\examples.

call_times2.h

typedef int my_int;

call_times2.c

#include "call_times2.h"

void call_times2(void)
{
  int times2result;

  func_times2(x1, &y1);

  printf('Times 2 Value:', y1);
}

This C code calls reusable function func_times2. The function multiplies an integer input value x1
by 2 and returns the result as y1.

Create Model

Open the example model ex_slfunc_comp, which is available in the folder matlabroot\help
\toolbox\ecoder\examples. The model includes two Simulink functions modeled as Simulink
Function blocks, func_times2 and func_times3, and a call to each function. As indicated in the
model, the visibility of the Simulink Function block for func_times2 is set to global. That visibility
setting makes the function code accessible to other code, including external code that you want to
integrate with the generated code. The visibility for func_times3 is set to scoped.
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If you configure the model with the GRT system target file or the ERT system target file with File
packaging format set to Modular, the code generator produces function code for the model.

For more information, see “Generate Code for a Simulink Function and Function Caller” on page 7-
15.

Configure Generated Code to Reuse Custom Data Type

The example assumes that the generated code runs on target hardware with a native integer size of
32 bits. The external code represents integers with data type my_int, which is an alias of int.
Configure the code generator to use my_int in place of the data type that the code generator uses by
default, which is int32_T.

1 Create a Simulink.AliasType object to represent the custom data type my_int.

my_int = Simulink.AliasType

my_int =

  AliasType with properties:

    Description: ''
      DataScope: 'Auto'
     HeaderFile: ''
       BaseType: 'double'

2 Set the alias type properties. Enter a description, set the scope to Imported, specify the header
file that includes the type definition, and associate the alias type with the Simulink base type
int32.

my_int.Description='Custom 32-bit int representation';
my_int.DataScope='Imported';
my_int.HeaderFile='call_times2.h';
my_int.BaseType='int32';

my_int
  AliasType with properties:

    Description: 'Custom 32-bit int representation'
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      DataScope: 'Imported'
     HeaderFile: 'call_times2.h'
       BaseType: 'int32'

3 Configure the code generator to replace instances of type int32_T with my_int. In the
Configuration Parameters dialog box, open the Code GenerationData Type Replacement pane.

• Select Replace data type names in the generated code.
• In the Data type names table, enter my_int for the replacement name for int32.

Configure Reusable, Global Function

For external code to call a global function, configure the corresponding Simulink Function block to
have global visibility and an interface that matches what is expected by the external callers.

1 Open the block that represents the times2 function.

2 Configure the function name and visibility by setting Trigger Port block parameters. For example,
the code requirements specify that the function name start with the prefix func_.

• Set Function name to func_times2.
• Set Function visibility to global.

3 Configure the function input and output arguments by setting Argument Inport and Argument
Outport block parameters. For example, the code requirements specify that argument names be
of the form xn and yn. The requirements also specify that arguments be type my_int.

• On the Main tab, set Argument name to x1 (input) and y1 (output).
• On the Signal Attributes tab, set Data type to int32. With the data type replacement that

you specified previously, int32 appears in the generated code as myint.
4 Configure the Simulink Function block code interface. At the top level of the model, right-click

the block representing global function func_times2. From the context menu, select C/C++
CodeConfigure C/C++ Function Interface.

• Set C/C++ function name to func_times2.
• Set C/C++ return argument to void.
• Set C/C++ Identifier Name for argument x1 to x1.
• Set C/C++ Identifier Name for argument y1 to y1.

If the dialog box lists output argument y1 before input argument x1, reorder the arguments by
dragging the row for x1 above the row for y1.
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Configure Local Function

Configure a Simulink Function block that represents a local function with scoped visibility. Based on
code requirements, you might also have to configure the function name, input and output argument
names and types, and the function interface.

1 Open the block that represents the times3 function.
2 Configure the function name and visibility by setting Trigger Port block parameters. For example,

the code requirements specify that the function name start with the prefix func_.

• Set Function name to func_times3.
• Set Function visibility to scoped.

3 Configure the function input and output arguments by setting Argument Inport and Argument
Outport block parameters. For example, the code requirements specify that argument names be
of the form xn and yn. The requirements also specify that arguments be type my_int.

• On the Main tab, set Argument name to x1 (input) and y1 (output).
• On the Signal Attributes tab, set Data type to int32. With the data type replacement that

you specified previously, int32 appears in the generated code as my_int.
4 Configure the Simulink Function block code interface. At the top level of the model, right-click

the scoped function func_times3. From the menu, select C/C++ CodeConfigure C/C++
Function Interface. In this case, the code generator controls naming the function and
arguments. The function name combines the name of the root model and the function name that
you specify for the trigger port of the Simulink Function block. In this example, the name is
ex_slfunc_comp_func_times3.

You can set C/C++ return argument to the argument name that you specify for the Argument
Outport block or void. For this example, set it to void.

For arguments, the code generator prepends rtu_ (input) or rty_ (output) to the argument
name that you specify for the Argument Inport block.

If the dialog box lists output argument y1 before input argument x1, reorder the arguments by
dragging the row for x1 above the row for y1.

Configure Function Callers

For each function caller, configure Function Caller block parameters:

• Set Function prototype to y1 = func_times2(x1).
• Set Input argument specifications to int32(1).
• Set Output argument specifications to int32(1).

Generate and Inspect Code

Generate code for the model.

• Global function code

Source code for the global, reusable function func_times2 is in the build folder in subsystem file,
func_times2.c.

#include "func_times2.h"
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/* Include model header file for global data */
#include "ex_slfunc_comp.h"
#include "ex_slfunc_comp_private.h"

void func_times2(my_int x1, my_int *y1)
{
  *y1 = x1 << 1;
}

• Local function code

The code generator places the definition for the local (scoped) function func_times3 in file build
folder in file ex_slfunc_comp.c.

void ex_slfunc_comp_func_times3(my_int rtu_x1, my_int *rty_y1)
{
  *rty_y1 = 3 * rtu_x1;
}

• Calls to generated functions

The model execution (step) function, in model file ex_slfunc_comp.c, calls the two Simulink
functions: global function func_times2 and local function ex_slfunc_comp_func_times3. The
name ex_slfunc_comp_func_times3 reflects the scope of the local function by combining the
name of the model and the name of the function.
void ex_slfunc_comp_step(void)
{
  my_int rtb_FunctionCaller2;

  func_times2(ex_slfunc_comp_U.In1, &rtb_FunctionCaller2);
  
  ex_slfunc_comp_Y.Out1 = rtb_FunctionCaller2;

  ex_slfunc_comp_func_times3(ex_slfunc_comp_U.In2, &rtb_FunctionCaller2);

  ex_slfunc_comp_Y.Out2 = rtb_functionCaller2;
  .
  .
  .

• Entry-point declaration for local function

The model header file ex_slfunc_comp.h includes an extern declaration for function
ex_slfunc_comp_func_times3. That statement declares the function entry point.

extern void ex_slfunc_comp_func_times3(my_int rtu_x1, my_int *rty_y1);

• Include statements for global function

The model header file ex_slfunc_comp.h lists include statements for the global
functionfunc_times2.

#include "func_times2_private.h"
#include "func_times2.h"

• Local macros and data for global function

The subsystem header file func_times2_private.h defines macros and includes header files
that declare data and functions for the global function, func_times2.

#ifndef RTW_HEADER_func_times2_private_h_
#define RTW_HEADER_func_times2_private_h_
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#ifndef ex_slfunc_comp_COMMON_INCLUDES_
#define ex_slfunc_comp_COMMON_INCLUDES_
#include "rtwtypes.h"
#endif
#endif

• Entry-point declaration for global function

The shared header file func_times2.h, in the shared utilities folder slprj/stf/
_sharedutils, lists shared type includes for rtwtypes.h. The file also includes an extern
declaration for the global function, func_times2. That statement declares the function entry
point.

#ifndef RTW_HEADER_func_times2_
#define RTW_HEADER_func_times2_

#include "rtwtypes.h"

extern void func_times2(my_int rtu_x1, my_int *rty_y1);

#endif

Generate Code for a Simulink Function and Function Caller
This example shows how to generate C code for Simulink Function and Function Caller blocks and
displays the relevant generated code.

Open the example model rtwdemo_export_functions. The model uses Stateflow software, but this
example reviews only the code generated from the referenced models.
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Generate Code for Function Definition

1 To view the contents of the subsystem, double-click rtwdemo_functions. The Simulink
Function block is the f3 subsystem defined as y = f3(u).

2 Generate code.

The code generator creates rtwdemo_functions.c. This file contains the function definition and
function initialization code.

• Initialization code for function f3:

void f3_Init(void)
{
  rtDWork.Delay_DSTATE = 1;
}

• Code for function f3:

void f3(real_T rtu_u, real_T *rty_y)
{
  rtY.TicToc10 = rtDWork.Delay_DSTATE;

  rtDWork.Delay_DSTATE = (int8_T)(int32_T)-(int32_T)rtY.TicToc10;

  adder_h(rtB.Subtract, rtU.U2, rtu_u, rtB.FunctionCaller);

  *rty_y = rtB.FunctionCaller;
}

void adder_h(real_T rtu_u1, 
             real_T rtu_u2, 
             real_T rtu_u3, 
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             real_T *rty_y)
{
  *rty_y = (rtu_u1 + rtu_u2) + rtu_u3;
}

• The shared header file f3.h contains the entry point declaration for function f3.

#include "rtwtypes.h"

extern void f3(real_T rtu_u, real_T *rty_y);

Generate Code for Function Caller

1 In the rtwdemo_export_functions model, double-click rtwdemo_caller to view the
contents of the caller subsystem.

2 Generate code.

The code generator creates the files rtwdemo_caller.h and rtwdemo_caller.c in the folder
rtwdemo_caller_ert_rtw.

rtwdemo_caller.h includes the shared header file, f3.h, which contains the function entry-point
declaration.

rtwdemo_caller.c calls function f3.

void rtwdemo_caller_t_10tic(const real_T *rtu_u, 
                            real_T *rty_y)
{
  f3(*rtu_u, rty_y);
}

See Also

More About
• “Generate Reentrant Code from Simulink Function Blocks”
• “Simulink Functions Overview”
• “Scoped Simulink Function Blocks in Models”
• “Simulink Function Blocks in Referenced Models”
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Generate Reentrant Code from Top Models
By default, for top models, the code generator produces code that is not reentrant. Entry-point
functions have a void-void interface. Code communicates with other code by sharing access to global
data structures that reside in shared memory.

For applications that can benefit from reuse and require that each use or instance of the code
maintains its own unique data, configure a model such that the code generator produces reentrant
code. To generate reentrant code, set the model configuration parameter “Code interface packaging”
to Reusable function. If you are using Embedded Coder and generating C++ code, alternatively,
you can set the parameter to C++ class. In both cases, the code generator:

• Packages model data, such as block I/O, DWork vectors, and parameters, in the real-time model
data structure (rtModel) .

• Passes the real-time model data structure as an input argument, by reference, to generated model
entry-point functions.

• Passes root-level input and output arguments to generated model entry-point functions as
individual arguments.

• Allocates memory for model data structures statically.
• Exports the real-time model data structure in the generated header file model.h.

Apply additional diagnostic and code generation control by setting these model configuration
parameters:

• To select the severity level for diagnostic messages that the code generator displays when a model
does not meet requirements for multi-instance code, set parameter “Multi-instance code error
diagnostic” to None, Warning, or Error. Set the parameter to Error unless you need to alter the
severity level for diagnostics displayed when a model violates requirements for generating multi-
instance code.

• To control how the generated code passes root-level model input and output to the reusable
execution (step) function (requires Embedded Coder), set parameter “Pass root-level I/O as” to
Individual arguments, Structure reference, or Part of model data structure.

When you set “Code interface packaging” to Reusable function, the code generator packages
model data (such as block I/O, Dwork, and parameters) into the real-time model data structure,
and passes the model structure to generated model entry-point functions. If you set “Pass root-
level I/O as” to Part of model data structure, the code generator packages root-level
model input and output into the real-time model data structure also.

• To reduce memory usage by omitting the error status field from the real-time model data structure
(requires Embedded Coder), select model configuration parameter Remove error status field in
real-time model data structure.

• To include a function in the generated file model.c that uses malloc to dynamically allocate
memory for model instance data (requires Embedded Coder), select model configuration
parameter Use dynamic memory allocation for model initialization. If you do not select this
parameter, the generated code statically allocates memory for model data structures.

Generate Reentrant, Multi-Instance Code
This example shows you how to configure a model for reentrant, multi-instance code generation.
Multiple programs can use reentrant code simultaneously. When you configure a model for
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reentrancy, the execution (step) entry-point function uses root-level input and output arguments
instead of global data structures. After examining the configuration settings, generate and review the
generated code.

Open the Model

Open the model rtwdemo_reusable. The model contains two root Inport blocks and a root Outport
block.

model='rtwdemo_reusable';
open_system(model);

Save a copy of the model to a writable location.

currentDir=pwd;
[~,cgDir] = rtwdemodir();

Examine Relevant Model Configuration Parameter Settings

1. Open the Embedded Coder app.

2. Open the Model Configuration Parameters dialog box.

3. Model configuration parameter System target file is set to ert.tlc. Although you can generate
reentrant code for a model configured with System target file set to grt.tlc, ERT and ERT-based
system target files provide more control over how the code passes root-level I/O.

4. Open the Code Generation > Interface pane and explore relevant model configuration
parameter settings.

• Code interface packaging is set to Reusable function. This parameter setting instructs the
code generator to produce reusable, multi-instance code.

• Setting of Reusable function displays parameter Multi-instance code error diagnostic.
That parameter is set to Error, indicating that the code generator abort if the model violates
requirements for generating multi-instance code.

• Pass root-level I/O as is set to Part of model data structure. This setting packages root-
level model input and output into the real-time model data structure (rtModel), which is an
optimized data structure that replaces SimStruct as the top-level data structure for a model.
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• Remove error status field in real-time model data structure is selected. This parameter
setting reduces memory usage by omitting the error status field from the generated real-time
model data structure.

Generate and Review Code

slbuild(model);

### Starting build procedure for: rtwdemo_reusable
### Successful completion of build procedure for: rtwdemo_reusable

Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
rtwdemo_reusable  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.048s

Review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code
controls model code execution by calling the entry-point function rtwdemo_reusable_step. Use
this file as a starting point for coding your execution framework.

• rtwdemo_reusable.c contains entry points for the code that implements the model algorithm.
This file includes the rate scheduling code.

• rtwdemo_reusable.h declare model data structures and a public interface to the model entry
points and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework.

1. Include the generated header file by adding directive #include rtwdemo_reusable.h.

2. Write input data to the generated code for model Inport blocks.

3. Call the generated entry-point functions.

4. Read data from the generated code for the model Outport block.

Input ports:

• <Root>/In1 of data real_T with dimension of 1
• <Root>/In2 of data real_T with dimension of 1

Entry-point functions:

• Initialization entry-point function, void rtwdemo_reusable_initialize(RT_MODEL *const
rtM). At startup, call this function once.
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• Output and update (step) entry-point function, void rtwdemo_reusable_step(RT_MODEL
*const rtM). Call this function periodically at the fastest rate in the model. For this model, call
the function every second. To achieve real-time execution, attach this function to a timer.

Output port:

• <Root>/Out1 of data type real_T with dimension of 1

Examine the Step Function

Examine the |rtwdemo_reusable_step| function code in |rtwdemo_reusable.c|.

cfile = fullfile(cgDir,'rtwdemo_reusable_ert_rtw','rtwdemo_reusable.c');
rtwdemodbtype(cfile,'/* Model step function', '/* Model initialize function ', 1, 0);

/* Model step function */
void rtwdemo_reusable_step(RT_MODEL *const rtM)
{
  D_Work *rtDWork = rtM->dwork;
  ExternalInputs *rtU = (ExternalInputs *) rtM->inputs;
  ExternalOutputs *rtY = (ExternalOutputs *) rtM->outputs;

  /* Outport: '<Root>/Out1' incorporates:
   *  UnitDelay: '<Root>/Delay'
   */
  rtY->Out1 = rtDWork->Delay_DSTATE;

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Sum: '<Root>/Sum'
   *  UnitDelay: '<Root>/Delay'
   */
  rtDWork->Delay_DSTATE = (rtU->In1 + rtU->In2) * rtP.k1;
}

The code generator passes model data to the rtwdemo_reusable_step function as part of the real-
time model data structure. Try different settings for model configuration parameters Code interface
packaging and Pass root-level I/O and regenerate code. Observe how the function prototype
changes.

Close the Model and Report

Close the model and the code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Share Data Between Instances
When your code calls a reentrant model entry-point function multiple times, each call represents an
instance of the model. By default, the code generator generates code that assumes each instance
reads from and writes to a separate copy of the signals, block states, and parameters in the model.
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• To share a piece of parameter data between the instances (for example, to share a setpoint for a
reusable PID control algorithm), use a parameter object, such as Simulink.Parameter. Then,
configure the parameter with a storage class other than Auto or in the Code Mappings editor, set
the default storage class for the corresponding category of parameter data Default (the default
setting) to Model default. The parameter object appears in the code as a global symbol, such as
a global variable, that the function accesses directly. For more information, see “C Code
Generation Configuration for Model Interface Elements”.

• To share a piece of nonparameter data between the instances (for example, to share a fault
indication or an accumulator), use a data store. You can configure the data store to appear in the
code as a global symbol, such as a global variable, that the function accesses directly. Create a
global data store by using a Simulink.Signal object or use a Data Store Memory block and
select block parameter Share across model instances. For more information, see “Model Global
Data by Creating Data Stores” and Data Store Memory.

See Also

More About
• “What Is Reentrant Code?” on page 7-3
• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “Storage Classes and Reentrant, Multi-Instance Models and Components”
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Generate Reentrant Code from Simulink Function Blocks
If you are using Embedded Coder, you can generate reusable, reentrant code by representing an
algorithm as a scoped Simulink Function block. Examples of when to generate reentrant code from
Simulink Function blocks are when a function shares state between function callers within a model or
for client/server applications. You can generate code that is highly modularized by using multiple
instances of a shared Simulink Function block in an export-function model. The code generator
produces function code and associates each use or call to the function with instance-specific data.
The scope of the function depends on whether you place the function at the root level of model or in a
subsystem.

The code generator produces reentrant function code when you configure a:

• Top model with model configuration parameter “Code interface packaging” set to Reusable
function or C++ class (C++ only).

• Referenced model with “Total number of instances allowed per top model” set to Multiple.

Call a function represented by a scoped Simulink Function block from one level above, at the same
level, or from a level below the level of the function definition. You can scope a function in an atomic
or nonvirtual subsystem, but function call accessibility is limited to the same level or below of the
hierarchy. The function name does not have to be unique.

Identify Requirements
Before and while you design your model, consider:

• How many instances of each function are required?
• Do you need to restrict call sites for a function to the model containing the function definition?
• Do you need for a function to interface with signals in the local environment, but keep those

signals hidden from callers?
• Do functions need to communicate directly with each other?
• Do functions need to connect to external I/O?
• Do you need to log function output?

Create Model
Use the example model component rtwdemo_comp to see how to use Simulink Function blocks to
generate reentrant C code. Use example model rtwdemo_comp_cpp if you prefer to generate C++
code. Open the model and examine the model hierarchy.

The top level of the model includes a function-call subsystem and two instances of a referenced
model.
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The referenced model, rtwdemo_func_dinteg, consists of a Simulink Function block that defines
function multiinstfunc and subsystem subsys_calc.

The subsystem consists of a Simulink Function block. This use of a Simulink Function block shows
how you can limit the scope of the function that the block defines to the model that contains the
subsystem. The code generator produces function code for func_calc and associates each call to
the function with instance-specific data. The data includes states, such as data stored in memory.

The Simulink Function block that defines function multiinstfunc uses a Function Caller block to
invoke function func_calc. That Simulink Function block also shows that it can interface to signals
in the local environment of the block through Inport and Outport blocks.
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At the top level of model rtwdemo_comp, the function-call subsystem uses Function Caller blocks to
invoke the two instances of function multiinstfunc. The code generator produces function code
and associates each call with instance-specific data.

Configure Model and Model Elements
Configure Simulink Function Blocks

Configure the Simulink Function blocks by setting parameters for the function Trigger Port block. For
the code generator to produce reentrant code from Simulink Function blocks:
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• Configure block instances with the same function name.
• Set block parameter Function visibility to scoped.

In the example, the function name for the Simulink Function blocks in the two instances of the
referenced model rtwdemo_func_dinteg is specified as multiinstfunc.

Configure Function Caller Blocks

Configure the Function Caller blocks. For each of the blocks, set block parameter Function
prototype. Start typing a prototype. For example, type y. Prototype options, based on function
definitions in the model, appear in a selection list. Select the prototype that corresponds to each
function call.

For this example, the prototypes are configured as follows:

• In the function-call subsystem, the prototypes for the function callers are configured as y =
Instance1.multiinstfunc(u) and y = Instance2.multiinstfunc(u). The Instancen
prefix identifies each function invocation uniquely and associates the invocation with its own data
set.

• The function caller in function multiinstfunc is configured with the prototype y =
subsys_calc.func_calc(u). The prefix subsys_calc identifies the subsystem that contains
the function definition.

For the example, the input and output argument specifications and sample time retain default
settings.

Subsystem Configuration

Configuration changes are not required for the subsystem in the example model. When you include a
Simulink Function block in a subsystem, the code generator

• Scopes the function to the model that includes the subsystem.
• Treats the subsystem as an atomic unit.

Configure Referenced Model

Configure the referenced model that includes a Simulink Function block:

• In the Block Parameters dialog box, set parameter Model name to the referenced model file
name. For this example, the model name is rtwdemo_func_dinteg.slx.

• Set model configuration parameter Total number of instances allowed per top model to
Multiple.

• To generate a C++ class interface for the reference model, set model configuration parameter
Language to C++ and parameter Code interface packaging to C++ class.

Optionally, you can customize model entry-point function interfaces. You can specify entry-point
function names. For the execution (step) entry-point function you can configure the function name
and arguments. Custom entry-point function interfaces can minimize changes to existing external
code that you integrate with the generated code. The example uses the default function interfaces.
See “Configure Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” on
page 40-2.

7 Code Reuse for Simulink Coder

7-26



Configure Top Model

Configure the top model for a model component. If you want the model component (that is, the top
model) to be reusable, set model configuration parameter Code interface packaging to Reusable
function. If you are generating C++ code, you can set this parameter to C++ class. In either case,
also:

• Set model configuration parameter Multi-instance code error diagnostic to Error.
• Set model configuration parameter Pass root-level I/O as to Part of model data

structure.

Optionally, you can customize model entry-point function interfaces. You can specify entry-point
function names. For the execution (step) entry-point function you can configure the function name
and arguments. Custom entry-point function interfaces can minimize changes to existing external
code that you integrate with the generated code. The example uses the default function interfaces.
See “Configure Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” on
page 40-2.

Generate and Inspect C Code
Generate C code for the model.

• Function code for multi-instance Simulink Function block

When you place a scoped Simulink Function block in a referenced model that you use multiple
times in another model, the code generator places the function code in the model.c file for the
referenced model. For this example, the code generator places function code for multiinstfunc
in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.c.
real_T rtwdemo_func_dinteg_multiinstfunc(RT_MODEL_rtwdemo_func_dinteg_T * const
  rtwdemo_func_dinteg_M, const real_T rtu_u)
{
  real_T rtb_TmpLatchAtInOutport1;
  real_T rtb_TmpLatchAtIn2Outport1;
  real_T rty_y_0;

  rtb_TmpLatchAtInOutport1 =
    *rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In1;

  rtb_TmpLatchAtIn2Outport1 =
    *rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In2;

  *rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out2 = 2.0 *
    rtb_TmpLatchAtInOutport1;
  
  rtwdemo_func_dinteg_func_calc(rtwdemo_func_dinteg_M, rtb_TmpLatchAtIn2Outport1,
    rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out1);

  rty_y_0 = rtwdemo_func_dinteg_M->dwork.DiscreteIntegrator_DSTATE;

  rtwdemo_func_dinteg_M->dwork.DiscreteIntegrator_DSTATE += 0.1 * rtu_u;
  return rty_y_0;
}

• Function code for a Simulink Function block defined in a subsystem

The code generator places the function code for a Simulink Function block that you define in a
subsystem in the model.c file for the model that contains the subsystem. For this example, the
code generator places the function code for func_calc in slprj/ert/rtwdemo_func_dinteg/
rtwdemo_func_dinteg.c.
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void rtwdemo_func_dinteg_func_calc(RT_MODEL_rtwdemo_func_dinteg_T * const
  rtwdemo_func_dinteg_M, real_T rtu_u, real_T *rty_y)
{
  rtwdemo_func_dinteg_M->dwork.calcMem =
    rtwdemo_func_dinteg_M->dwork.UnitDelay_DSTATE;

  *rty_y = rtwdemo_func_dinteg_M->dwork.UnitDelay_DSTATE;

  rtwdemo_func_dinteg_M->dwork.UnitDelay_DSTATE = rtu_u * 0.07;
}

• Structure that stores multi-instance data for reusable functions

The code generator uses a structure similar to the real-time model (RT_MODEL) data structure to
store the multi-instance data associated with a reusable function. The code generator defines the
structure in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.h.
typedef struct rtwdemo_func_dinteg_tag_RTM RT_MODEL_rtwdemo_func_dinteg_T;

• Initialization code for multi-instance referenced model

For each instance of a referenced model that includes the same scoped Simulink Function block,
the code generator produces initialization and startup function code. A single copy of the
initialization code is defined in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.c.
void rtwdemo_func_dinteg_Start(RT_MODEL_rtwdemo_func_dinteg_T *const
  rtwdemo_func_dinteg_M, const real_T *rtu_In1, const real_T *rtu_In2, real_T
  *rty_Out2, real_T *rty_Out1)
{
  rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In1 = rtu_In1;
  rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In2 = rtu_In2;
  rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out2 = rty_Out2;
  rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out1 = rty_Out1;
}

void rtwdemo_func_dinteg_initialize(const char_T **rt_errorStatus,
  RT_MODEL_rtwdemo_func_dinteg_T *const rtwdemo_func_dinteg_M)
{
  {
    rtmSetErrorStatusPointer(rtwdemo_func_dinteg_M, rt_errorStatus);
  }
}

The initialization code is called for each instance of a referenced model that contains the same
Simulink Function block. That code is in file rtwdemo_comp.c in the build folder.
.
.
.
rtwdemo_func_dinteg_initialize(rtmGetErrorStatusPointer(rtwdemo_comp_M),
  (&(rtwdemo_comp_M->Instance1)));
  
rtwdemo_func_dinteg_initialize(rtmGetErrorStatusPointer(rtwdemo_comp_M),
  (&(rtwdemo_comp_M->Instance2)));

rtwdemo_func_dinteg_Start((&(rtwdemo_comp_M->Instance1)), &rtU->In2, &rtU->In3,
  &rtY->Out2, &rtY->Out3);
  
rtwdemo_func_dinteg_Start((&(rtwdemo_comp_M->Instance2)), &rtU->In4, &rtU->In5,
  &rtY->Out4, &rtY->Out5);
}

• Top model entry-point function declarations

The model header file rtwdemo_comp.h includes extern declarations for top model initialize,
terminate, and execution (run) entry-point functions.
extern void rtwdemo_comp_initialize(RT_MODEL_rtwdemo_comp_T *const
  rtwdemo_comp_M);
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extern void Run(RT_MODEL_rtwdemo_comp_T *const rtwdemo_comp_M);

• Reference model entry-point function declarations

Header file slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.h includes extern
declarations for reference model entry-point functions.
extern void rtwdemo_func_dinteg_initialize(const char_T **rt_errorStatus,
  RT_MODEL_rtwdemo_func_dinteg_T *const rtwdemo_func_dinteg_M);
extern real_T rtwdemo_func_dinteg_multiinstfunc(RT_MODEL_rtwdemo_func_dinteg_T * 
  const rtwdemo_func_dinteg_M, const real_T rtu_u);
extern void rtwdemo_func_dinteg_Start(RT_MODEL_rtwdemo_func_dinteg_T *const 
  rtwdemo_func_dinteg_M, const real_T *rtu_In1, const real_T *rtu_In2, real_T
  *rty_Out2, real_T *rty_Out1);

Generate and Inspect C++ Code
Generate C++ code for the model.

• Function code for multi-instance Simulink Function block

When you place a scoped Simulink Function block in a referenced model that you use multiple
times in another model, the code generator places the function code in the model.cpp file for the
referenced model. For this example, the code generator places function code for multiinstfunc
in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.cpp.
real_T rtwdemo_func_dintegModelClass::multiinstfunc(const real_T rtu_u)
{
  real_T rtb_TmpLatchAtInOutport1;
  real_T rtb_TmpLatchAtIn2Outport1;
  real_T rty_y_0;

  rtb_TmpLatchAtInOutport1 = *rtwdemo_func_dinteg_cprtrtu_In1;

  rtb_TmpLatchAtIn2Outport1 = *rtwdemo_func_dinteg_cprtrtu_In2;

  *rtwdemo_func_dinteg_crtrty_Out2 = 2.0 * rtb_TmpLatchAtInOutport1;

  rtwdemo_func_dinteg_c_func_calc(rtb_TmpLatchAtIn2Outport1,
    rtwdemo_func_dinteg_crtrty_Out1);

  rty_y_0 = rtwdemo_func_dinteg_cpprtDW.DiscreteIntegrator_DSTATE;

  rtwdemo_func_dinteg_cpprtDW.DiscreteIntegrator_DSTATE += 0.1 * rtu_u;
  return rty_y_0;
}

• Function code for a Simulink Function block defined in a subsystem

The code generator places the function code for a Simulink Function block that you define in a
subsystem in model.cpp for the model that contains the subsystem. For this example, the code
generator places the function code for func_calc in slprj/ert/rtwdemo_func_dinteg/
rtwdemo_func_dinteg_cpp.cpp.
void rtwdemo_func_dintegModelClass::rtwdemo_func_dinteg_c_func_calc(real_T rtu_u,
  real_T *rty_y)
{
  rtwdemo_func_dinteg_cpprtDW.calcMem =
    rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE;

  *rty_y = rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE;

  rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE = rtu_u * 0.07;
}
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• Structure that stores multi-instance data for reusable functions

The code generator uses a structure similar to the real-time model (RT_MODEL) data structure to
store the multi-instance data associated with a Reusable function. The code generator defines
the structure in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.h.
typedef struct rtwdemo_func_dinteg_cpp_tag_RTM rtwdemo_func_dinteg_cp_RT_MODEL;

• Initialization code for multi-instance referenced model

For each instance of a referenced model that includes the same scoped Simulink Function block,
the code generator produces initialization and startup function code. A single copy of the
initialization code is defined in slprj/ert/rtwdemo_func_dinteg/
rtwdemo_func_dinteg_cpp.cpp.
void rtwdemo_func_dintegModelClass::start(real_T *rtu_In1, real_T *rtu_In2,
  real_T *rty_Out2, real_T *rty_Out1)
{
  rtwdemo_func_dinteg_cprtrtu_In1 = rtu_In1;
  rtwdemo_func_dinteg_cprtrtu_In2 = rtu_In2;
  rtwdemo_func_dinteg_crtrty_Out2 = rty_Out2;
  rtwdemo_func_dinteg_crtrty_Out1 = rty_Out1;
}
.
.
.
void rtwdemo_func_dintegModelClass::initializeRTM()
{
  (void) memset((void *)((&rtwdemo_func_dinteg_cpprtM)), 0,
                sizeof(rtwdemo_func_dinteg_cp_RT_MODEL));
}

The initialization code is called for each instance of a referenced model that contains the same
Simulink Function block. That code is in file rtwdemo_comp_cpp.cpp in the build folder.
.
.
.

Instance1MDLOBJ0.initializeRTM();

Instance1MDLOBJ0.setErrorStatusPointer(rtmGetErrorStatusPointer((&rtM)));
Instance1MDLOBJ0.initialize();

Instance2MDLOBJ1.initializeRTM();

Instance2MDLOBJ1.setErrorStatusPointer(rtmGetErrorStatusPointer((&rtM)));
    
Instance1MDLOBJ0.start(&rtU.In2, &rtU.In3, &rtY.Out2, &rtY.Out3);

Instance2MDLOBJ1.start(&rtwU.In4, &rtwU.In5, &rtY.Out4, &rtY.Out5);
}

• Top model class declaration

The model header file rtwdemo_comp_cpp.h includes the class declaration for the top model.
class rtwdemo_compModelClass {
 public:
  ExtU rtU;

  ExtY rtY;

  void initialize();

  void Run();

  rtwdemo_compModelClass();
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  ~rtwdemo_compModelClass();

  RT_MODEL * getRTM();

 private:
  RT_MODEL rtM;

  rtwdemo_func_dintegModelClass Instance1MDLOBJ0;

  rtwdemo_func_dintegModelClass Instance2MDLOBJ1;
};

• Reference model class declaration

Header file slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.h includes the
class declaration for the reference model.

class rtwdemo_func_dintegModelClass {
 public:
  real_T multiinstfunc(const real_T rtu_u);

  void start(real_T *rtu_In1, real_T *rtu_In2, real_T *rty_Out2, real_T
                *rty_Out1);

  rtwdemo_func_dintegModelClass();
    
  ~rtwdemo_func_dintegModelClass();

  rtwdemo_func_dinteg_cp_RT_MODEL * getRTM();

  void initializeRTM();

  void setErrorStatusPointer(const char_T **rt_errorStatus);

 private:
  rtwdemo_func_dinteg_cpp_DW rtwdemo_func_dinteg_cpprtDW;

  const real_T *rtwdemo_func_dinteg_cprtrtu_In1;
  const real_T *rtwdemo_func_dinteg_cprtrtu_In2;
  real_T *rtwdemo_func_dinteg_crtrty_Out2;
  real_T *rtwdemo_func_dinteg_crtrty_Out1;

  rtwdemo_func_dinteg_cp_RT_MODEL rtwdemo_func_dinteg_cpprtM;

  void rtwdemo_func_dinteg_c_func_calc(real_T rtu_u, real_T *rty_y);
};

Limitations
These code generation limitations apply to export-function models that include multiple instances of a
Simulink Function block.

• You must set the model configuration parameter Pass root-level I/O as to Part of model
data structure.

• Generated code is compatible with single-threaded execution only. To avoid race conditions for
shared signal data, invoke instances of the function code from the same execution thread.

• You cannot:

• Generate code if the export-function model includes model variants.
• Call the generated code from a Stateflow chart.
• Enable the external mode data exchange interface.
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See Also

More About
• “Simulink Functions Overview”
• “Simulink Functions”
• “Simulink Function Blocks in Referenced Models”
• “Storage Classes and Reentrant, Multi-Instance Models and Components”
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Generate Reentrant Code from Subsystems
You can reduce the amount of code that the code generator produces for identical atomic subsystems
by configuring the subsystems as reusable functions that pass data as arguments (for example, rtB_*
for block input and output, rtDW_* for continuous states, and rtP_* for parameters) . By default, the
code generator produces subsystem code that communicates with other code by sharing access to
global data structures that reside in shared memory. By passing data as arguments, the code can be
reentrant. Each instance of the code maintains its own unique data.

To configure subsystems for reusability and reentrancy, configure mask and block parameters of the
identical subsystems the same way. The code generator performs a checksum to determine whether
subsystems are identical and whether the code is reusable. If the code is reusable, the code generator
produces a single instance of reusable, reentrant function code.

To configure the subsystem block parameters:

1 If a subsystem is virtual, select block parameter “Treat as atomic unit” to enable function
packaging parameters.

2 Set block parameter “Function packaging” to Reusable function. The code generator
produces a separate function with arguments for each subsystem. Selecting Reusable
function also enables additional parameters that you can use to control the names of the
function and file that the code generator produces for the subsystem code.

3 Select a value for block parameter “Function name options”. To generate reusable, reentrant
code, specify the same setting for identical subsystems.

• To let the code generator determine the function name, select Auto.
• To use the subsystem name or, for a library block, the name of the library block, select Use

subsystem name.
• To display block parameter “Function name” and enter a unique, valid C/C++ function name,

select User specified.

If multiple instances of an identical subsystem exist within a model reference hierarchy, select
Auto.

If you are using Embedded Coder, you can use identifier format controls. See “Identifier Format
Control” on page 53-15.

4 Set “File name options”. To generate reusable, reentrant code, specify the same setting for
identical subsystems.

• To let the code generator determine file naming select Auto.
• To use the subsystem name or, for a library block, the name of the library block select Use

subsystem name.
• To use the function name, as specified by block parameter Function name options select

Use function name.
• To display block parameter “File name (no extension)” and enter a file name, excluding the

extension (for example, .c or .cpp) select User specified.

Other considerations:

• If multiple instances of an identical subsystem exist within a model reference hierarchy, select
Auto.
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• If the code generator does not generate a separate file for a subsystem, the function code is
placed in the file generated from the subsystem's parent system. If the parent is the model
itself, the code generator places the function code in model.c or model.cpp.

• If your generated code is under source control, specify a value other than Auto. This
specification prevents the generated file name from changing when you modify and rebuild
the model.

• If you select Use subsystem name, the code generator mangles the subsystem file name if
the model contains Model blocks, or if a model reference target is being generated for the
model. In these situations, the code generator uses the file name modelsubsystem.c.

If subsystem A has mask parameter b and K and subsystem B has mask parameters c and K, code
reuse is not possible. The code generator produces separate functions for subsystems A and B. If you
set block parameters for subsystems A and B differently, code reuse is not possible.

Function Reuse in Generated Code
This example shows how to configure an atomic subsystem for generating reusable code. To specify
that the code generated for a subsystem execute as an atomic unit, on the Block Parameters dialog
box, select the Treat as atomic unit parameter . That parameter enables the Function Packaging
parameter on the Code Generation tab. The Function Packaging parameter has these four
settings:

• Inline: Inline the subsystem code
• Nonreusable function: Function with I/O passed as global data
• Reusable function: Function with I/O passed as function arguments
• Auto: Let Simulink Coder optimize based on context

The Reusable function and Auto settings permit the code generator to reuse subsystem code.
The Reusable function and Nonreusable function settings enable the Function name
options, Function name, and File name options parameters.

If you have an Embedded Coder license, you can configure a nonreusable subsystem to accept
arguments.

Example Model

The rtwdemo_ssreuse model contains two identical subsystems, SS1 and SS2. For these
subsystems, the Function packaging parameter is set to Reusable function, and the Function
name parameter is myfun. The subsystems are parameterized masked subsystems. To see the
contents of the masked subsystems, right-click the subsystem blocks and select Mask > Look Under
Mask.

model = 'rtwdemo_ssreuse';
open_system(model);
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Generate and Inspect Code

Create a temporary folder for the build and inspection process. Open the Simulink Coder or
Embedded Coder app. Then, generate and inspect the code.

currentDir=pwd;
[~,cgDir]=rtwdemodir();
slbuild(model)

### Starting build procedure for: rtwdemo_ssreuse
### Successful completion of build procedure for: rtwdemo_ssreuse

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                                    
================================================================================================
rtwdemo_ssreuse  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.359s

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_ssreuse_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */

  /* Inport: '<Root>/In1' incorporates:
   *  Inport: '<Root>/In2'
   */
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  myfun(rtwdemo_ssreuse_U.In1, rtwdemo_ssreuse_U.In2, rtwdemo_ssreuse_P.T1Data,
        rtwdemo_ssreuse_P.T1Break, &rtwdemo_ssreuse_B.SS1);

  /* End of Outputs for SubSystem: '<Root>/SS1' */

  /* Outport: '<Root>/Out1' */
  rtwdemo_ssreuse_Y.Out1 = rtwdemo_ssreuse_B.SS1.LookupTable;

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */

  /* Inport: '<Root>/In1' incorporates:
   *  Inport: '<Root>/In2'
   */
  myfun(rtwdemo_ssreuse_U.In1, rtwdemo_ssreuse_U.In2, rtwdemo_ssreuse_P.T2Data,
        rtwdemo_ssreuse_P.T2Break, &rtwdemo_ssreuse_B.SS2);

  /* End of Outputs for SubSystem: '<Root>/SS2' */

  /* Outport: '<Root>/Out2' */
  rtwdemo_ssreuse_Y.Out2 = rtwdemo_ssreuse_B.SS2.LookupTable;
}

In the model step function, there are two calls to the reusable function, myfun. The mask parameters,
T1Break, T1Data, T2Break, and T2Data, are function arguments.

Change the Function Packaging parameter to Inline.

set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Inline')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Inline')

Generate and inspect the code.

slbuild(model)

### Starting build procedure for: rtwdemo_ssreuse
### Successful completion of build procedure for: rtwdemo_ssreuse

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                   
===============================================================================
rtwdemo_ssreuse  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.345s

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_ssreuse_step(void)
{
  real_T Out1_tmp;

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */
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  /* Sum: '<S1>/Sum' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Sum: '<S2>/Sum'
   */
  Out1_tmp = rtwdemo_ssreuse_U.In1 + rtwdemo_ssreuse_U.In2;

  /* End of Outputs for SubSystem: '<Root>/SS2' */

  /* Outport: '<Root>/Out1' incorporates:
   *  Lookup_n-D: '<S1>/Lookup Table'
   *  Sum: '<S1>/Sum'
   */
  rtwdemo_ssreuse_Y.Out1 = look1_binlx(Out1_tmp, rtwdemo_ssreuse_P.T1Break,
    rtwdemo_ssreuse_P.T1Data, 10U);

  /* End of Outputs for SubSystem: '<Root>/SS1' */

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  /* Outport: '<Root>/Out2' incorporates:
   *  Lookup_n-D: '<S2>/Lookup Table'
   */
  rtwdemo_ssreuse_Y.Out2 = look1_binlx(Out1_tmp, rtwdemo_ssreuse_P.T2Break,
    rtwdemo_ssreuse_P.T2Data, 10U);

  /* End of Outputs for SubSystem: '<Root>/SS2' */
}

In the model step function, the subsystem code is inlined.

Change the Function Packaging parameter to Nonreusable function. For SS2 , change the
Function name parameter to myfun2.

set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Nonreusable function')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Nonreusable function')
set_param('rtwdemo_ssreuse/SS2','RTWFcnName','myfun2')

Generate and inspect the code.

slbuild(model)

### Starting build procedure for: rtwdemo_ssreuse
### Successful completion of build procedure for: rtwdemo_ssreuse

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                   
===============================================================================
rtwdemo_ssreuse  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.098s

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

/* Model step function */

 Generate Reentrant Code from Subsystems

7-37



void rtwdemo_ssreuse_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */
  myfun();

  /* End of Outputs for SubSystem: '<Root>/SS1' */

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  myfun2();

  /* End of Outputs for SubSystem: '<Root>/SS2' */
}

The model step function contains calls to the functions myfun and myfun2. These functions have a
void-void interface.

Change the Function Packaging parameter to Auto.

set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Auto')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Auto')

For the auto setting, Simulink Coder chooses the optimal format. For this model, the optimal format
is a reusable function.

Close the model and clean up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Limitations
• The code generator uses a checksum to determine whether subsystems are identical and reusable.

Subsystem code is not reused if:

• In blocks and data objects, you use symbols to specify dimensions.
• A port has different sample times, data types, complexity, frame status, or dimensions across

subsystems.
• The output of a subsystem is marked as a global signal.
• Subsystems contain identical blocks with different names or parameter settings.
• The output of a subsystem is connected to a Merge block, and the output of the Merge block is
configured with a custom storage class that is implemented in the C code as nonaddressable
memory (for example, BitField).

• The input of a subsystem is nonscalar and is configured with a custom storage class that is
implemented in the C code as nonaddressable memory.

• A masked subsystem has a parameter that is nonscalar and is configured with a custom
storage class that is implemented in the C code as nonaddressable memory.

• A function-call subsystem uses mask parameters when you set the model configuration
parameter “Default parameter behavior” to Tunable. To reuse the masked function-call
subsystem, place it inside a new atomic subsystem without a mask. Then move the Trigger
block from the masked subsystem into the atomic subsystem.

• A block in a subsystem uses a partially tunable expression. Some partially tunable expressions
disable code reuse.
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Partially tunable expressions are expressions that contain one or more tunable variables and
an expression that is not tunable. For example, suppose that you create the tunable variable K
with value 15.23 and the tunable variable P with value [5;7;9]. The expression K+P' is a
partially tunable expression because the expression P' is not tunable. For more information
about tunable expression limitations, see “Tunable Expression Limitations”.

• For subsystems that contain S-function blocks that are reusable, the blocks must meet the
requirements listed in “S-Functions for Code Reuse” on page 13-85.

• If you select Reusable function, and the code generator determines that you cannot reuse the
code for a subsystem, it generates a separate function that is not reused. The code generation
report might show that the separate function is reusable, even if only one subsystem uses it. If you
prefer that the code generator inline subsystem code in such cases (rather than deployed as
functions), set “Function packaging” to Auto.

• If a reusable subsystem uses a shared local data store and you configure default mapping for
model data elements, leave the default storage class mapping for category Shared local data
stores set to Default.

• Use of these blocks in a subsystem can prevent the subsystem code from being reused:

• Scope blocks (with data logging enabled)
• S-Function blocks that fail to meet certain criteria (see “S-Functions for Code Reuse” on page

13-85)
• To File blocks (with data logging enabled)
• To Workspace blocks (with data logging enabled)

• For reusable library subsystems (subsystems shared across reference models), the code generator
uses a checksum to determine whether subsystems are identical. The code generator places the
reusable library subsystem code in the shared utilities folder, and the reusable code is
independent of the generated code of the top model or the reference model. For example, the
reusable library subsystem code does not include model.h or model_types.h.

Reusable code that the code generator places in the shared utilities folder and is dependent on the
model code does not compile. If the code generator determines that the reusable library
subsystem code is dependent on the model code, the reusable subsystem code is not placed in the
shared utilities folder. The code generator produces code that is dependent on the model code
when the reusable library subsystem:

• Contains a block that uses time-related functionality, such as a Step block, or continuous time
or multirate blocks.

• Contains one or more Model blocks.
• Contains a subsystem that is not inlined or a reusable library subsystem.
• Contains a signal or parameter with a storage class that places the data declaration in a file

under model_ert_rtw (For example, ExportedGlobal storage class places data in
model.c)

• Contains a user-defined storage class like Enumeration, Simulink.Signal, Simulink.Parameter,
and so on where Data Scope is not set to Exported. The code generator might place the type
definition in model_types.h.

• Is a variant subsystem that generates preprocessor conditionals. The code generator places
preprocessor directives that define the variant objects in model_types.h

• You cannot reuse a subsystem if there are multiple instances of the same subsystem in the model
and one subsystem is fed by a Constant block but the other subsystem is not. To work around this
limitation, insert a Signal Conversion block before the subsystems.
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• Two reusable subsystems that have different checksums cannot share the same function in the
generated code. When you specify the same function name for both subsystems in Block
Parameters (Subsystem) > Code Generation > Function name:

• If the subsystems are library-linked, the code generator mangles the function name to generate
unique function names. The code generator uses the subsystem naming rules to generate the
function names.

• If the subsystems are not library-linked, the code generator issues an error.

The preceding limitations also apply for library-based code generation. For more information, see
“Library-Based Code Generation for Reusable Library Subsystems” on page 8-2.

See Also

More About
• “What Is Reentrant Code?” on page 7-3
• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “Generate Reusable Code from Library Subsystems Shared Across Models” on page 7-41
• “Control Generation of Functions for Subsystems” on page 3-2
• “Storage Classes and Reentrant, Multi-Instance Models and Components”
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Generate Reusable Code from Library Subsystems Shared
Across Models

What Is a Reusable Library Subsystem?
A reusable library subsystem is a subsystem included in a library that is configured for reuse. You
must define a subsystem in a library and configure it for reuse to reuse the subsystem across models.

To reuse common functionality, you can include multiple instances of a subsystem:

• Within a single model, which is a top model or part of model reference hierarchy
• Across multiple referenced models in a model reference hierarchy
• Across multiple top models that contain Model blocks
• Across multiple top models that do not include Model blocks

The code generator uses checksums to determine reusability. There are cases when the code
generator cannot reuse subsystem code.

For incremental code generation, if the reusable library subsystem changes, a rebuild of itself and its
parents occurs. During the build, if a matching function is not found, a new instance of the reusable
function is generated into the shared utilities folder. If a different matching function is found from
previous builds, that function is used, and a new reusable function is not emitted.

For subsequent builds, unused files are not replaced or deleted from your folder. During development
of a model, when many obsolete shared functions exist in the shared utilities folder, you can delete
the folder and regenerate the code. If all instances of a reusable library subsystem are removed from
a model reference hierarchy and you regenerate the code, the obsolete shared functions remain in
the shared utilities folder until you delete them.

If a model changes such that the change might cause different generated code for the subsystem, a
new reusable function is generated. For example, model configuration parameters that modify code
comments might cause different generated code for the subsystem even if the reusable library
subsystem did not change.

Embedded Coder users can generate code from a library that contains subsystems are configured for
reuse. For more information, see “Library-Based Code Generation for Reusable Library Subsystems”
on page 8-2.

Reusable Library Subsystem Code Placement and Naming
The generated code of a reusable library subsystem is independent of the generated code of the
model. Code for the reusable library subsystem is generated to the shared utility folder, slprj/
target/_sharedutils, instead of the model reference hierarchy folders. The generated code for
the supporting types, which are generated to the .h file, are also in the shared utilities folder.

For unique naming, reusable function names have a checksum appended to the reusable library
subsystem name. For example, the code and files for a subsystem, SS1, which links to a reusable
library subsystem, RLS, might be:

• Function name: RLS_mgdjlngd
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• File name: RLS_mgdjlnd.c and RLS_mgdjlnd.h

Configure Reusable Library Subsystem
Set the Subsystem parameters as listed here:

• Select Treat as an atomic unit.
• On the Code Generation tab:

• Set Function packaging to Reusable function.
• Set the Function name options

and File name options parameters to one of the following combinations:

• Set Function name options and File name options to Auto.
• Set Function name options to Use subsystem name and File name options to Use

function name.
• Set Function name options to User specified and File name options to Auto or Use

function name.
• Set Function name options to User specified and File name options to User

specified. Set the same value for the Function name and File name parameters.

In a model reference hierarchy, if an instance of the reusable library subsystem is in the top model,
then on the Model Referencing pane of the Configuration Parameters dialog box, you must select
the Pass fixed-size scalar root input by value for code generation parameter. If you do not select
the parameter, a separate shared function is generated for the reusable library subsystem instance in
the top model, and a reusable function is generated for instances in the referenced models.

If a reusable library subsystem is connected to the root Outport, reuse does not happen with identical
subsystems that are not connected to the root Outport. However, you can set Pass reusable system
outputs as to Individual arguments on the Optimizations pane to make sure that reuse occurs
between these subsystems. This parameter requires an Embedded Coder license.

For more information on creating a library, see “Custom Libraries”. For an example of creating a
reusable library subsystem, see “Generate Reusable Code for Subsystems Shared Across Models”.

Configure Models That Include Reusable Library Subsystems
For a model to use a reusable library subsystem, you must configure the model differently depending
on whether the model is a reference model or top model. If the subsystem is in a referenced model
hierarchy, set the configuration parameter, “Shared code placement” to Auto. Otherwise, for each
model that uses the subsystem, set the model configuration parameter Shared code placement to
Shared location.

If a reusable library subsystem uses a shared local data store and you configure default mapping for
model data elements, leave the default storage class mapping for category Shared local data stores
set to Default.
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Generate Reusable Code for Subsystems Shared Across Models
This example shows how to configure a reusable library subsystem and generate a reusable function
for a subsystem shared across referenced models. The result is reusable code for the subsystem,
which is generated to the shared utility folder (slprj/target/_sharedutils).

• “Create a reusable library subsystem.” on page 7-43
• “Create the example model.” on page 7-46
• “Set configuration parameters of the top model.” on page 7-47
• “Create and propagate a configuration reference.” on page 7-47
• “Generate and view the code.” on page 7-48

Create a reusable library subsystem.

1 In the Simulink Editor, on the Simulation tab, select New > Library. Select Blank Library
from the Simulink Start Page window. Open rtwdemo_ssreuse to copy and paste subsystem
SS1 into the Library Editor. This action loads the variables for SS1 into the base workspace.
Rename the subsystem block to RLS.
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2 Click the Subsystem block and press Ctrl+U to view the contents of subsystem RLS.
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3 To configure the subsystem, in the Library editor, right-click RLS. In the context menu, select
Block Parameters (Subsystem). In the Subsystem Parameters dialog box, choose the following
options:

• Select Treat as an atomic unit.
• On the Code Generation tab:

• Set Function packaging to Reusable function.
• Set Function name options to User specified and verify that the Function name is

set to myfun.
• Set File name options to Auto.

4 Click Apply and OK.
5 Save the reusable library subsystem as ssreuselib, which creates a file, ssreuselib.slx.
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Create the example model.

1 Create a model which includes one instance of RLS from ssreuselib. Name this subsystem
SS1. Add another subsystem and name it SS2. Name the model ex_model1.

2 Create another model which includes one instance of RLS from ssreuselib. Name this
subsystem SS1. Add another subsystem and name it SS3. Name the model ex_model2.

3 Create a top model with two model blocks that reference ex_model1 and ex_model2. Save the
top model as ex_mdlref_ssreuse.
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Set configuration parameters of the top model.

1 With model ex_mdlref_ssreuse open in the Simulink Editor, on the C Code tab, click Settings
to open the Configuration Parameters dialog box.

2 On the Solver pane, specify the Type as Fixed-step.
3 On the Model Referencing pane, select Pass fixed-size scalar root inputs by value for code

generation.
4 On the Code Generation > Report pane, select Create code generation report and Open

report automatically.
5 On the Code Generation > Interface pane, set the “Shared code placement” to Shared

location.
6 On the Code Generation > Identifiers pane, set the Maximum identifier length to 256. This

step is optional.
7 Click Apply and OK.

Create and propagate a configuration reference.

1 In the Simulink Editor, on the Modeling tab, click Model Explorer to open the Model Explorer.
In the left navigation column of the Model Explorer, expand the ex_mdlref_ssreuse node.

2 Select the Configurations node below the ex_mdlref_ssreuse node. In the Contents pane,
right-click Configuration and select Convert to Configuration Reference.

3 In the Convert Active Configuration to Reference dialog box, click OK. This action converts the
model configuration set to a configuration reference, Simulink.ConfigSetRef, and creates
the configuration reference object, configSetObj, in the base workspace.

4 In the left navigation column, right-click Reference (Active) and select Propagate to
Referenced Models.

5 In the Configuration Reference Propagation to Referenced Models dialog box, select the
referenced models in the list. Click Propagate.
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Now, the top model and referenced models use the same configuration reference, Reference
(Active), which points to a model configuration reference object, configSetObj, in the base
workspace. When you save your model, you also need to export the configSetObj to a MAT-file.

Generate and view the code.

1 To generate code, in the Simulink Editor, press Ctrl+B. After the code is generated, the code
generation report opens.

2 To view the code generation report for a referenced model, in the left navigation pane, in the
Referenced Models section, select ex_model1. The code generation report displays the
generated files for ex_model1.

3 In the left navigation pane, expand the Shared files. The code generator uses the reusable
library subsystem name. The code for subsystem SS1 is in myfun.c and myfun.h.

4 Click Back and navigate to the ex_model2 code generation report. ex_model2 uses the same
source code, myfun.c and myfun.h, as the code for ex_model1. Your subsystem function and
file names will be different.
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See Also

More About
• “Custom Libraries”
• “Generate Reentrant Code from Subsystems” on page 7-33
• “Control Generation of Functions for Subsystems” on page 3-2
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Generate Reusable Code from Stateflow Atomic Subcharts

Generate Reusable Code for Linked Atomic Subcharts
To specify code generation parameters for linked atomic subcharts from the same library:

1 Open the library model that contains your atomic subchart.
2 Unlock the library.
3 Right-click the library chart and select Block Parameters.
4 In the dialog box, specify the following parameters:

a On the Main tab, select parameter Treat as atomic unit.
b On the Code Generation tab, set parameter Function packaging to Reusable

function.
c Set File name options to User specified.
d For File name, enter the name of the file without an extension.
e Click OK to apply the changes.

5 (OPTIONAL) Customize the generated function names for atomic subcharts:

a Set model configuration parameter System target file to ert.tlc.
b For model configuration parameter Subsystem methods, specify the format of the function

names using a combination of the following naming rule tokens:

• $R — root model name
• $F — type of interface function for the atomic subchart
• $N — block name
• $H — subsystem index
• $M — name-mangling text

c Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for linked atomic subcharts
from the same library.

Generate Reusable Code for Unlinked Atomic Subcharts
To specify code generation parameters for an unlinked atomic subchart:

1 In your chart, right-click the atomic subchart and select Properties.
2 In the dialog box, specify the following properties:

a Set property Code generation function packaging to Reusable function.
b Set Code generation file name options to User specified.
c For Code generation file name, enter the name of the file without extension.
d Click OK to apply the changes.

3 (OPTIONAL) Customize the generated function names for atomic subcharts:
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a Set model configuration parameter System target file to ert.tlc.
b For model configuration parameter Subsystem methods, specify the format of the function

names using a combination of the following naming rule tokens:

• $R — root model name
• $F — type of interface function for the atomic subchart
• $N — block name
• $H — subsystem index
• $M — name-mangling text

c Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for the atomic subchart. For
more information, see “Generate Code from Atomic Subcharts” on page 12-5.

Generate Reusable Code for Unit Testing
Convert a State to an Atomic Subchart

To convert state A to an atomic subchart, right-click the state and select Group & Subchart >
Atomic Subchart. State A changes to an atomic subchart:

Set Up a Standalone C File for the Atomic Subchart

1 Open the properties dialog box for A.
2 Set property Code generation function packaging to Reusable function.
3 Set Code generation file name options to User specified.
4 For Code generation file name, enter saturator as the name of the file.
5 Click OK.

Set Up the Code Generation Report

1 Set model configuration parameter System target file to ert.tlc.
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2 Select model configuration parameters Create code generation report and Open report
automatically.

3 Select parameters Code-to-model and Model-to-code.
4 Click Apply.

Customize the Generated Function Names

1 Set model configuration parameter Subsystem methods to the format scheme $R$N$M$F,
where:

• $R is the root model name.
• $N is the block name.
• $M is the mangle token.
• $F is the type of interface function for the atomic subchart.

For more information, see “Subsystem methods”.
2 Click Apply.

Generate Code for Only the Atomic Subchart

To generate code for your model, press Ctrl+B. In the code generation report that appears, you see a
separate file that contains the generated code for the atomic subchart.

To inspect the code for saturator.c, click the hyperlink in the report to see the following code:
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Line 28 shows that the during function generated for the atomic subchart has the name
ex_reuse_states_A_during. This name follows the format scheme $R$N$M$F specified for
Subsystem methods:

• $R is the root model name, ex_reuse_states.
• $N is the block name, A.
• $M is the mangle token, which is empty.
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• $F is the type of interface function for the atomic subchart, during.

Note The line numbers shown can differ from the numbers that appear in your code generation
report.

File Packaging for Atomic Subsystems (Code Only)

This model shows how to partition an atomic subsystem into its own source file. Once a subsystem is
specified as atomic, on the Subsystem Block Parameter dialog, on the Code Generation tab, you can
specify how the subsystem is represented in the generated code using the Function packaging
parameter:

• Inline: an Inlined function
• Function: function with I/O passed as global data
• Reusable function: function with I/O passed as function arguments
• Auto: Simulink Coder optimizes based on context

With the Function and Reusable function options, you can specify a function and file name with
Function name and File name, respectively. In the model, rtwdemo_filepart, SS1 subsystem is
configured as Reusable function with function name myfun and file name myfile.

open_system('rtwdemo_filepart')

This capability only partitions the code for a subsystem. The data is declared and owned by the
parent model. For full system encapsulation (i.e., data and functions), use Model Reference.
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bdclose('rtwdemo_filepart');

See Also

More About
• “Model Reactive Systems in Stateflow” (Stateflow)
• “Encapsulate Modal Logic by Using Subcharts” (Stateflow)
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Generate Shared Utility Code
When to Generate Shared Utility Code
Blocks in a model can require common functionality to implement their algorithms. Consider
modularizing this functionality into standalone support or helper functions. This approach can be
more efficient than inlining the code for the functionality for each block instance. To decide about
using a library or a shared utility, consider:

• Packaging functions that can have multiple callers into a library when the functions are defined
statically. That is, before you use the code generator to produce code for your model, the function
source code exists in a file.

• Packaging functions that can have multiple callers as shared utilities (produced during code
generation) when the functions cannot be defined statically. For example, several model- and
block-specific properties specify which functions are used and their behavior. Also, these
properties determine type definitions (for example, typedef) in shared utility header files. The
number of possible combinations of properties that determine unique behavior make it impractical
to define statically the possible function files before code generation.

Configure Naming of Generated Functions
Configure a default naming rule for generated shared utility functions by using one of these methods.

Configuration Action
A new model or an existing model for which you
have mapped default customization settings by
using the Code Mappings editor or code
mappings programming interface

In the Embedded Coder Dictionary, define a
function customization template that specifies a
custom function naming rule. Then, in the Code
Mappings editor or by using the code mappings
programming interface, map the Shared utility
function category to that template. For more
information, see “Configure Default C Code
Generation for Categories of Data Elements and
Functions” on page 33-15.

A model created in a release earlier than R2018a
and that has not been configured with the Code
Mappings editor or code mappings
programming interface

Set the model configuration parameter Shared
utilities identifier format
(CustomSymbolsStrUtil) to a custom function
naming rule. For more information, see
“Identifier Format Control” on page 53-15.

Once you use the Code Mappings editor or code mappings programming interface to configure a
model, setting model configuration parameter Shared utilities identifier format does not impact
code generation. This setting is not applicable for models configured with these specifications.

System Target File Programming Language
ert.tlc C++
autosar.tlc C
autosar_adaptive.tlc C++

The naming rule for shared utility functions must include the conditional checksum token $C. To
customize the length of the checksum that the code generator produces, use parameter Shared
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checksum length (SharedChecksumLength) . Increasing the length of the checksum reduces the
probability of clashes.

This example shows the customization of shared utility function names for C code generation.

1 Open the example model rtwdemo_configdefaults and the Embedded Coder app.
2 Set model configuration parameter Shared code placement to Shared location.
3 Open the Embedded Coder Dictionary. On the C Code tab, select Code Interface > Embedded

Coder Dictionary.
4 On the Function Customization Templates tab, click Add to add a new function customization

template.
5 For the function customization template, specify these configurations:

• Name: exSharedUtility
• Function Name: mymodel_$N$C

You can customize this format by using a string. You must include token $C.
6 Open the Code Mappings editor. On the C Code tab, select Code Interface > Default Code

Mappings.
7 On the Function Defaults tab, for the Shared Utility category, configure Function

Customization Template as exSharedUtility.
8 Generate code and a code generation report.
9 In the left navigation pane of the report, review the list of generated files for shared utilities

under Shared files.

Control Placement of Shared Utility Code
Control placement of shared utility code with the model configuration parameter Shared code
placement. The default option value is Auto. For this setting, the code generator places required
code for fixed-point and other utilities in the model.c file, the model.cpp file, or a separate file in
the build folder (for example, vdp_grt_rtw) if a model does not contain existing shared utility code
or one of these blocks:

• Model blocks
• Simulink Function blocks
• Function Caller blocks
• Calls to Simulink Functions from Stateflow or MATLAB Function blocks
• Stateflow graphical functions when you select parameter Export Chart Level Functions

If a model contains one or more of the preceding blocks, the code generator creates and uses a
shared utilities folder within slprj. The naming convention for shared utility folders is slprj/
target/_sharedutils. target is sim for simulations with Model blocks or the name of the system
target file for code generation.
slprj/sim/_sharedutils      % folder used with simulation
slprj/grt/_sharedutils      % folder used with grt.tlc STF
slprj/ert/_sharedutils      % folder used with ert.tlc STF
slprj/mytarget/_sharedutils % folder used with mytarget.tlc STF

To force a model build to use the slprj folder for shared utility generation, even when the current
model does not contain existing shared utility code or one of the preceding blocks, set parameter
Shared code placement to Shared location. The code generator places utilities under the slprj
folder rather than in the normal build folder. This setting is useful when you are manually combining
code from several models, because it prevents symbol collisions between the models.
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Control Placement of rtwtypes.h for Shared Utility Code
The generated rtwtypes.h header file provides fundamental type definitions, #define statements,
and enumerations. For more information, see “rtwtypes.h” on page 50-39.

Control placement of rtwtypes.h file by selecting whether the build process uses the shared utilities
folder. If the model build uses a shared utilities folder, the build process places rtwtypes.h in
slprj/target/_sharedutils. Otherwise, the software places rtwtypes.h in
model_target_rtw.

Adding a model to a model hierarchy or changing an existing model in the hierarchy can result in
updates to the shared rtwtypes.h file during code generation. If updates occur, recompile and,
depending on your development process, reverify previously generated code. To minimize updates to
the rtwtypes.h file, make the following changes in the Configuration Parameters dialog box:

• Select model configuration parameter Support: complex numbers even if the model does not
currently use complex data types. Selecting this parameter protects against a future requirement
to add support for complex data types when integrating code.

• Clear parameter Support non-inlined S-functions. If you use noninlined S-functions in the
model, this option generates an error.

• Clear parameter Classic call interface. This parameter setting disables use of the GRT system
target file.

Avoid Duplicate Header Files for Exported Data
Exported header files appear in the shared utility folder when:

• You control the file placement of declarations for signals, parameters, and states by defining and
applying storage classes.

• The code generator places utility code in a shared location.

For example, you can specify a header file for data by using:

• A storage class that you define in the Embedded Coder Dictionary and map to categories of
model data in the Code Mappings editor.

• The Code Generation tab in a Signal Properties dialog box.
• The HeaderFile property of a data object. Data objects are objects of the classes

Simulink.Signal and Simulink.Parameter.

If you want the declaration to appear in the file model.h, it is a best practice to leave the header file
name unspecified. By default, the code generator places data declarations in model.h.

If you specify model.h as the header file name, and if the code generator places utility code in a
shared location, you cannot generate code from the model. The code generator cannot create the file
model.h in both the model build folder and the shared utility folder.

Reduce Shared Utility Code Generation with Incremental Builds
You can specify that the model build generates C source files in a shared utilities folder. See
“Generate Shared Utility Code”. These files include C source files that contain function definitions
and header files that contain macro definitions. For this discussion, the term functions means
functions and macros.
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Blocks within the same model and blocks in different models can use a shared function when you use
model reference or when you build multiple standalone models from the same start build folder. The
code generator produces the code for a given function only once for the block that first triggers code
generation. As the product determines the requirement to generate function code for subsequent
blocks, it performs a file existence check. If the file exists, the model build does not regenerate the
function. The shared utility code mechanism requires that a given function and file name represent
the same functional behavior regardless of which block or model generates the function. To satisfy
this requirement:

• Model properties that determine function behavior contribute to the shared utility checksum or
determine the function and file name.

• Block properties that determine the function behavior also determine the function and file name.

During compilation, makefile rules for the shared utilities folder select compilation of only new C files
and incrementally archive the object file into the shared utility library, rtwshared.lib, or
rtwshared.a. Incremental compilation also occurs.

Manage the Shared Utility Code Checksum
When you set the model configuration parameter Shared code placement to Shared location or
when the model contains Model blocks, the code generator places shared code in the shared utilities
folder. The build process generates a shared utilities checksum of the code generation configuration
for the shared code.

During subsequent code generation, if the checksum file slprj/target/_sharedutils/
checksummap.mat exists relative to the current folder, the code generator reads that file. The code
generator verifies that the current model that you are building has configuration properties that
match the checksum of properties from the shared utility model. If mismatches occur between the
properties defined in checksummap.mat and the current model properties, you see an error. Use the
error message to manage the checksum (for example, diagnose and resolve the configuration issues
with the current model).

View the Shared Utility Checksum Hash Table

It is helpful to view the property values that contribute to the checksum. This example uses the
rtwdemo_lct_start_term.slx model. To load the checksum.mat file into MATLAB and view the
targetInfoStruct that defines the checksum-related properties:

1 Open the rtwdemo_lct_start_term.slx model. In the Command Window, type:
rtwdemo_lct_start_term

2 Create and move to a new working folder.
mkdir C:\Temp\demo
cd C:\Temp\demo

3 Save a copy of the model in the folder.
4 Build the model, which is set up to produce shared utilities.

a On the Apps tab, under Code Generation, click Simulink Coder.
b On the C Code tab, in the Generate Code section, click the Build button.

5 Move to the _sharedutils folder created by the build process.
cd C:\Temp\demo\slprj\grt\_sharedutils
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6 Load the checksummap.mat file into MATLAB.
load checksummap

7 Display the contents of hashTbl.targetInfoStruct and examine the checksum-related
property values.
hashTbl.targetInfoStruct

For this example, the Command Window displays hashTbl.targetInfoStruct for the shared
utilities that you generated from the model:

ans = 

 struct with fields:

                   ShiftRightIntArith: 'on'
               ProdShiftRightIntArith: 'on'
                            Endianess: 'LittleEndian'
                        ProdEndianess: 'LittleEndian'
                          wordlengths: '8,16,32,32,64,32,64,64,64,64'
                      Prodwordlengths: '8,16,32,32,64,32,64,64,64,64'
                       TargetWordSize: '64'
                         ProdWordSize: '64'
                   TargetHWDeviceType: 'Custom Processor->MATLAB Host Computer'
                     ProdHWDeviceType: 'Intel->x86-64 (Windows64)'
                  TargetIntDivRoundTo: 'Zero'
                    ProdIntDivRoundTo: 'Zero'
    UseDivisionForNetSlopeComputation: 'off'
                    PurelyIntegerCode: 'off'
                    PortableWordSizes: 'off'
               SupportNonInlinedSFcns: ''
                  RTWReplacementTypes: ''
                            MaxIdInt8: 'MAX_int8_T'
                            MinIdInt8: 'MIN_int8_T'
                           MaxIdUint8: 'MAX_uint8_T'
                           MaxIdInt16: 'MAX_int16_T'
                           MinIdInt16: 'MIN_int16_T'
                          MaxIdUint16: 'MAX_uint16_T'
                           MaxIdInt32: 'MAX_int32_T'
                           MinIdInt32: 'MIN_int32_T'
                          MaxIdUint32: 'MAX_uint32_T'
                           MaxIdInt64: 'MAX_int64_T'
                           MinIdInt64: 'MIN_int64_T'
                          MaxIdUint64: 'MAX_uint64_T'
                        BooleanTrueId: 'true'
                       BooleanFalseId: 'false'
     TypeLimitIdReplacementHeaderFile: ''
                 SharedCodeRepository: ''
                           TargetLang: 'C'
             PreserveExternInFcnDecls: 'on'
              EnableSignedRightShifts: 'on'
               EnableSignedLeftShifts: 'on'
                              TflName: 'None'
                          TflCheckSum: [453906543 3.9179e+09 
                                        3.7907e+09 269412680]
               UtilMemSecPreStatement: ''
              UtilMemSecPostStatement: ''
                    UtilMemSecComment: ''
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                 CodeCoverageChecksum: [3.6498e+09 78774415 
                                        2.5508e+09 2.1183e+09]
           TargetLargestAtomicInteger: 'Char'
             TargetLargestAtomicFloat: 'None'
             ProdLargestAtomicInteger: 'Char'
               ProdLargestAtomicFloat: 'Float'
                         LongLongMode: 'on'
                     ProdLongLongMode: 'off'
                       toolchainOrTMF: 'Microsoft Visual C++ 2017 v15.0 | 
                                        nmake (64-bit Windows)'

Relate the Shared Utility Checksum to Configuration Parameters

Examine the targetInfoStruct hash table from the shared utility model. Some key-value pairs
relate directly to a model property. Other pairs relate to groups of properties.

The following table describes the key-value pairs.

Key Names Model Properties
ShiftRightIntArith TargetShiftRightIntArith
ProdShiftRightIntArith ProdShiftRightIntArith
Endianess TargetEndianess
ProdEndianess ProdEndianess
wordlengths TargetBitPerChar, TargetBitPerShort,

TargetBitPerInt, TargetBitPerLong,
TargetBitPerLongLong,
TargetBitPerFloat, TargetBitPerDouble,
TargetBitPerPointer

Prodwordlengths ProdBitPerChar, ProdBitPerShort,
ProdBitPerInt, ProdBitPerLong,
ProdBitPerLongLong, ProdBitPerFloat,
ProdBitPerDouble, ProdBitPerPointer

TargetWordSize TargetWordSize
ProdWordSize ProdWordSize
TargetHWDeviceType TargetHWDeviceType
ProdHWDeviceType ProdHWDeviceType
TargetIntDivRoundTo TargetIntDivRoundTo
ProdIntDivRoundTo ProdIntDivRoundTo
UseDivisionForNetSlopeComputation UseDivisionForNetSlopeComputation
PurelyIntegerCode PurelyIntegerCode
PortableWordSizes PortableWordSizes
SupportNonInlinedSFcns SupportNonInlinedSFcns
RTWReplacementTypes EnableUserReplacementTypes,

ReplacementTypes
MaxIdInt8 MaxIdInt8
MinIdInt8 MinIdInt8
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Key Names Model Properties
MaxIdUint8 MaxIdUint8
MaxIdInt16 MaxIdInt16
MinIdInt16 MinIdInt16
MaxIdUint16 MaxIdUint16
MaxIdInt32 MaxIdInt32
MinIdInt32 MinIdInt32
MaxIdUint32 MaxIdUint32
MaxIdInt64 MaxIdInt64
MinIdInt64 MinIdInt64
MaxIdUint64 MaxIdUint64
BooleanTrueId BooleanTrueId
BooleanFalseId BooleanFalseId
TypeLimitIdReplacementHeaderFile TypeLimitIdReplacementHeaderFile
SharedCodeRepository Reserved (internal use only)
TargetLang TargetLang
PreserveExternInFcnDecls PreserveExternInFcnDecls
EnableSignedRightShifts EnableSignedRightShifts
EnableSignedLeftShifts EnableSignedLeftShifts
TflName CodeReplacementLibrary
TflCheckSum Reserved (internal use only)
UtilMemSecPreStatement MemSecFuncSharedUtil, MemSecPackage
UtilMemSecPostStatement MemSecFuncSharedUtil, MemSecPackage
UtilMemSecComment MemSecFuncSharedUtil, MemSecPackage
CodeCoverageChecksum Reserved (internal use only)
TargetLargestAtomicInteger TargetLargestAtomicInteger
TargetLargestAtomicFloat TargetLargestAtomicFloat
ProdLargestAtomicInteger ProdLargestAtomicInteger
ProdLargestAtomicFloat ProdLargestAtomicFloat
LongLongMode TargetLongLongMode
ProdLongLongMode ProdLongLongMode
CollapseNonTrivialExpressions Reserved (internal use only)
toolchainOrTMF Name of:

• Toolchain if build process uses either a
toolchain (Toolchain) or a template makefile
that is associated with a toolchain.

• Template makefile if build process uses
template makefile (TemplateMakefile).
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See Also

More About
• “Generate Shared Utility Code for Fixed-Point Functions”
• “Generate Shared Utility Code for Custom Data Types”
• “Cross-Release Shared Utility Code Reuse”
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
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Generate Shared Utility Code for Fixed-Point Functions
An important set of generated functions that the model build places in the shared utility folder are
the fixed-point support functions. Based on model and block properties, there are many possible
versions of fixed-point utilities functions that make it impractical to provide a complete set as static
files. Generating only the required fixed-point utility functions during the code generation process is
an efficient alternative.

The shared utility checksum mechanism makes sure that several critical properties are identical for
models that use the shared utilities. For the fixed-point functions, there are additional properties that
determine function behavior. The mechanism codes these properties into the functions and file names
to maintain requirements. The additional properties include:

Category Function/Property
Block properties • Fixed-point operation that the block performs

• Fixed-point data type and scaling (Slope, Bias) of function inputs and
outputs

• Overflow handling mode (Saturation, Wrap)
• Rounding Mode (Floor, Ceil, Zero)

Model properties get_param(bdroot, 'NoFixptDivByZeroProtection')

The property-based naming convention for the fixed-point utilities is as follows:
operation + [zero protection] + output data type + output bits + 
[input1 data] + input1 bits + [input2 data type + input2 bits] + 
[shift direction] + [saturate mode] + [round mode]

The file names shown are examples of generated fixed-point utility files. The function or macro names
in the file are identical to the file name without the extension.
FIX2FIX_U12_U16.c 
FIX2FIX_S9_S9_SR99.c
ACCUM_POS_S30_S30.h
MUL_S30_S30_S16.h
div_nzp_s16s32_floor.c
div_s32_sat_floor.c

For these examples, the table shows how the respective fields correspond.

The ACCUM_POS example uses the output variable as one of the input variables. So, the file and macro
name only contain the output and second input.

The second div example has identical data type and bits for both inputs and the output. So, the file
and function name only include the output.

Operation FIX2FIX FIX2FIX ACCUM_POS MUL div div
Zero protection NULL NULL NULL NULL _nzp NULL
Output data type _U _S _S _S _s _s
Output bits 12 9 30 30 16 32
Input data type _U _S _S _S [and _S] s NULL
Input bits 16 9 30 30 [and 16] 32 NULL
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Operation FIX2FIX FIX2FIX ACCUM_POS MUL div div
Shift direction NULL SR99 NULL NULL NULL NULL
Saturate mode NULL NULL NULL NULL NULL _sat
Round mode NULL NULL NULL NULL _floor _floor

See Also

More About
• “Generate Shared Utility Code”
• “Generate Shared Utility Code for Custom Data Types”
• “Cross-Release Shared Utility Code Reuse”
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Generate Shared Utility Code for Custom Data Types
By default, if a model employs a custom data type (such as a Simulink.AliasType object or an
enumeration class), the code generator places the corresponding type definition (typedef) in the
model_types.h file. When you generate code from multiple models, each model duplicates the type
definition. These duplicate definitions can prevent you from compiling the bodies of generated code
together.

However, you can configure the code generator to place a single type definition in a header file in the
_sharedutils folder. Then, when you generate code from a model, if the type definition already
exists in the _sharedutils folder, the code generator does not duplicate the definition, but instead
reuses it through inclusion (#include).

Through this mechanism, you can share:

• Simulink data type objects that you instantiate from the classes Simulink.AliasType,
Simulink.Bus, and Simulink.NumericType. For basic information about creating and using
these objects, see “Control Data Type Names in Generated Code” on page 36-2 and
Simulink.Bus.

• Enumerations that you define, for example, by authoring an enum class in a script file or by using
the function Simulink.defineIntEnumType. For basic information about defining enumerations
in Simulink, see “Use Enumerated Data in Simulink Models”.

To share a custom data type across multiple models:

1 Define the data type. For example, create the Simulink.AliasType object.
2 Set data scope and header file properties to specific values that enable sharing.

For a data type object, set the DataScope property to 'Exported' and, optionally, specify the
header file name through the HeaderFile property.

For an enumeration that you define as an enum class in a script file, implement the
getDataScope method (with return value 'Exported') and, optionally, implement the
getHeaderFile method.

For an enumeration that you define by using the Simulink.defineIntEnumType function, set
the 'DataScope' pair argument to 'Exported' and, optionally, specify the 'HeaderFile'
pair argument

3 Use the data type in the models.
4 Before generating code from each model, set the model configuration parameter Shared code

placement to Shared location.
5 Generate code from the models.

Note You can configure the definition of the custom data type to appear in a header file in the
_sharedutils folder. The shared utility functions that the model build generates into the
_sharedutils folder do not use the custom data type name. Only model code located in code
folders for each model uses the custom data type name.
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See Also

More About
• “Generate Shared Utility Code”
• “Generate Shared Utility Code for Fixed-Point Functions”
• “Cross-Release Shared Utility Code Reuse”
• “Control File Placement of Custom Data Types” on page 36-19
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Shared Constant Parameters for Code Reuse
You can share the generated code for constant parameters across models if either of the following
conditions applies:

• Constant parameters are shared in a model reference hierarchy.
• The model configuration parameter “Shared code placement” is set to Shared location.

If you do not want to generate shared constants, and model configuration parameter Shared code
placement is set to Shared location, set parameter GenerateSharedConstants to off. For
example, to turn off shared constants for the current model, in the Command Window, type the
following.

set_param(gcs,'GenerateSharedConstants','off');

When the model configuration parameter GenerateSharedConstants is set to off, the code
generator generates the constant parameters shared across the model reference hierarchy in a
shared location, in the slprj/target/_sharedutils folder but outside the const_params.c file.
The code generator defines the individual constant parameters in the reusable library subsystem files
individually.

When the model configuration parameter GenerateSharedConstants is set to on, the code
generator produces shared constant parameters individually and places them in the file
const_params.c. The code generator places that file in the shared utilities folder slprj/target/
_sharedutils.

For example, if a constant has multiple uses within a model reference hierarchy where the top model
is named topmod, the code for the shared constant is as follows:

• In the shared utility folder, slprj/grt/_sharedutils, the constant parameters are defined in
const_params.c and named rtCP_pooled_ appended to a unique checksum:
extern const real_T rtCP_pooled_lfcjjmohiecj[7];
const real_T rtCP_pooled_lfcjjmohiecj[7] = { 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0 };

extern const real_T rtCP_pooled_ppphohdbfcba[7];
const real_T rtCP_pooled_ppphohdbfcba[7] = { 7.0, 6.0, 5.0, 4.0, 3.0, 2.0, 1.0 };

• In top_model_private.h or in a referenced model, ref_model_private.h, for better
readability, the constants are renamed as follows:
extern const real_T rtCP_pooled_lfcjjmohiecj[7];
extern const real_T rtCP_pooled_ppphohdbfcba[7];

#define rtCP_Constant_Value   rtCP_pooled_lfcjjmohiecj  /* Expression: [1 2 3 4 5 6 7]
                                                         * Referenced by: '<Root>/Constant'*/
#define rtCP_Gain_Gain        rtCP_pooled_ppphohdbfcba  /* Expression: [7 6 5 4 3 2 1]
                                                         * Referenced by: '<Root>/Gain' */

• In topmod.c or refmod.c, the call site might be:
for (i = 0; i < 7; i++) {
   topmod_Y.Out1[i] = (topmod_U.In1 + rtCP_Constant_Value[i]) * rtCP_Gain_Gain[i];
}

The code generator attempts to generate constants as individual constants to the const_params.c
file in the shared utilities folder. Otherwise, constants are generated as described in “Code
Generation of Constant Parameters” on page 3-12.
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Suppress Shared Constants in the Generated Code
You can choose whether the code generator produces shared constants and shared functions. You
might want to be able to keep the code and data separate between subsystems, or you might find that
sharing constants results in a memory shortage during code generation.

You can change this setting programmatically by using the parameter GenerateSharedConstants
with set_param and get_param.

In the following example, when GenerateSharedConstants is set to on, the code generator defines
the constant values in the_sharedutils folder in the const_params.c file. When
GenerateSharedConstants is set to off, the code generator defines the constant values in a
nonshared area, in the model_ert_rtw file in the model_data.c file.

Open the model rtwdemo_throttlecntrl:

Verify that model configuration parameter “Shared code placement” is set to Shared location. If
the parameter is set to Auto, the code generator ignores setting GenerateSharedConstants. If
you try to set the parameter value, an error message appears. By default, value
GenerateSharedConstants is selected.

In the Command Window, set GenerateSharedConstants to on:
>> set_param('rtwdemo_throttlecntrl','GenerateSharedConstants','on')

You see the shared constant definitions in the folder slprj/grt/_sharedutils, in the file
const_params.c:
extern const real_T rtCP_pooled_H4eTKtECwveN[9];
const real_T rtCP_pooled_H4eTKtECwveN[9] = { 1.0, 0.75, 0.6, 0.0, 0.0, 0.0, 0.6,
  0.75, 1.0 } ;

extern const real_T rtCP_pooled_SghuHxKVKGHD[9];
const real_T rtCP_pooled_SghuHxKVKGHD[9] = { -1.0, -0.5, -0.25, -0.05, 0.0, 0.05,
  0.25, 0.5, 1.0 } ;

extern const real_T rtCP_pooled_WqWb2t17NA2R[7];
const real_T rtCP_pooled_WqWb2t17NA2R[7] = { -1.0, -0.25, -0.01, 0.0, 0.01, 0.25,
  1.0 } ;

extern const real_T rtCP_pooled_Ygnal0wM3c14[7];
const real_T rtCP_pooled_Ygnal0wM3c14[7] = { 1.0, 0.25, 0.0, 0.0, 0.0, 0.25, 1.0
} ;
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In the Command Window, set GenerateSharedConstants to off:

>> set_param('rtwdemo_throttlecntrl','GenerateSharedConstants','off')

You can see the unshared constants in the folderrtwdemo_throttlecntrl_grt_rtw, in the file
rtwdemo_throttlecntrl_data.c:

/* Constant parameters (auto storage) */
const ConstP_rtwdemo_throttlecntrl_T rtwdemo_throttlecntrl_ConstP = {
  /* Pooled Parameter (Expression: P_OutMap)
   * Referenced by:
   *   '<S2>/Proportional  Gain Shape'
   *   '<S3>/Proportional  Gain Shape'
   */
  { 1.0, 0.25, 0.0, 0.0, 0.0, 0.25, 1.0 },

  /* Pooled Parameter (Expression: P_InErrMap)
   * Referenced by:
   *   '<S2>/Proportional  Gain Shape'
   *   '<S3>/Proportional  Gain Shape'
   */
  { -1.0, -0.25, -0.01, 0.0, 0.01, 0.25, 1.0 },

  /* Pooled Parameter (Expression: I_OutMap)
   * Referenced by:
   *   '<S2>/Integral  Gain Shape'
   *   '<S3>/Integral  Gain Shape'
   */
  { 1.0, 0.75, 0.6, 0.0, 0.0, 0.0, 0.6, 0.75, 1.0 },

  /* Pooled Parameter (Expression: I_InErrMap)
   * Referenced by:
   *   '<S2>/Integral  Gain Shape'
   *   '<S3>/Integral  Gain Shape'
   */
  { -1.0, -0.5, -0.25, -0.05, 0.0, 0.05, 0.25, 0.5, 1.0 }
};

Shared constant Parameters Limitations

The code generator does not produce shared constants for a model when:

• The model has a code replacement library (CRL) that is specified for data alignment.
• The model is specified to replace data type names in the generated code.
• The Memory Section for constants is MemVolatile or MemConstVolatile.
• The parameter GenerateSharedConstants is set to off.

Individual constants are not shared, if:

• A constant is referenced by a non-inlined S-function.
• A constant has a user-defined type where Data Scope is not set to Exported.

See Also

More About
• “Generate Reentrant Code from Subsystems” on page 7-33
• “Generate Reusable Code from Library Subsystems Shared Across Models”
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Determine Why Subsystem Code Is Not Reused
Due to the limitations described in “Generate Reentrant Code from Subsystems”, the code generator
might not reuse generated code as you expect. To determine why code generated for a subsystem is
not reused:

1 Review the Subsystems section of the code generation report.
2 Compare subsystem checksum data.

Review Subsystems Section of HTML Code Generation Report
If the code generator does not generate code for a subsystem as reusable code, and you configured
the subsystem as reusable, examine the Subsystems section of the code generation report (see
“Generate a Code Generation Report”). The Subsystems section contains:

• A table that summarizes how nonvirtual subsystems were converted to generated code.
• Diagnostic information that describes why subsystems were not generated as reusable code.

The Subsystems section also maps noninlined subsystems in the model to functions or reused
functions in the generated code. For an example, open and build the rtwdemo_atomic model.

Compare Subsystem Checksum Data
You can determine why subsystem code is not reused by comparing subsystem checksum data. The
code generator determines whether subsystems are identical by comparing subsystem checksums, as
noted in “Limitations”. For subsystem reuse across referenced models, this procedure might not flag
every difference.

Consider the model, rtwdemo_ssreuse. SS1 and SS2 are instances of the same subsystem. In both
instances the subsystem block parameter Function packaging is set to Reusable function.

Use the method Simulink.SubSystem.getChecksum to get the checksum for a subsystem. Review
the results to determine why code is not reused.

1 Open the model rtwdemo_ssreuse. Save a copy of the model in a folder where you have write
access.

2 Associate the subsystems SS1 and SS2 with gcb. For each of the subsystems , in the model
window, select the subsystem. While the subsystem is selected, in the Command Window, enter:

SS1 = gcb;

SS2 = gcb;

 Determine Why Subsystem Code Is Not Reused

7-71

matlab:rtwdemo_atomic
matlab:rtwdemo_ssreuse
matlab:rtwdemo_ssreuse


3 Use the method Simulink.SubSystem.getChecksum to get the checksum for each subsystem.
This method returns two output values: the checksum value and details on the input used to
compute the checksum.

[chksum1, chksum1_details] = ...
Simulink.SubSystem.getChecksum(SS1);
[chksum2, chksum2_details] = ...
Simulink.SubSystem.getChecksum(SS2);

4 Compare the two checksum values. The values should be equal based on the subsystem
configurations.

isequal(chksum1, chksum2)
ans =
     1

5 To use Simulink.SubSystem.getChecksum to determine why the checksums of two
subsystems differ, change the data type mode of the output port of SS1 so that it differs from that
of SS2.

a Look under the mask of SS1. Right-click the subsystem. In the context menu, select Mask >
Look Under Mask.

b In the block diagram of the subsystem, double-click the Lookup Table block to open the
Subsystem Parameters dialog box.

c Click Data Types.
d Select block parameter Saturate on integer overflow and click OK.

6 Get the checksum for SS1. Compare the checksums for the two subsystems. This time, the
checksums are not equal.

[chksum1, chksum1_details] = ...
Simulink.SubSystem.getChecksum(SS1);
isequal(chksum1, chksum2)
ans =
     0

7 After you determine that the checksums are different, find out why. The Simulink engine uses
information, such as signal data types, some block parameter values, and block connectivity
information, to compute the checksums. To determine why checksums are different, compare the
data that computes the checksum values. You can get this information from the second value
returned by Simulink.SubSystem.getChecksum, which is a structure array with four fields.

Look at the structure chksum1_details.

chksum1_details

chksum1_details = 
          ContentsChecksum: [1x1 struct]
         InterfaceChecksum: [1x1 struct]
     ContentsChecksumItems: [287x1 struct]
    InterfaceChecksumItems: [53x1 struct]

ContentsChecksum and InterfaceChecksum are component checksums of the subsystem
checksum. The remaining two fields, ContentsChecksumItems and
InterfaceChecksumItems, contain the checksum details.

8 Determine whether a difference exists in the subsystem contents, interface, or both. For example:
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isequal(chksum1_details.ContentsChecksum.Value,...
        chksum2_details.ContentsChecksum.Value)
ans =
     0
isequal(chksum1_details.InterfaceChecksum.Value,...
        chksum2_details.InterfaceChecksum.Value)
ans =
     1

In this case, differences exist in the content.
9 Write a script like this script to find the differences.

idxForCDiffs=[];
for idx = 1:length(chksum1_details.ContentsChecksumItems)
    if (~strcmp(chksum1_details.ContentsChecksumItems(idx).Identifier, ...
                chksum2_details.ContentsChecksumItems(idx).Identifier))
            disp(['Identifiers different for contents item ', num2str(idx)]); 
            idxForCDiffs=[idxForCDiffs, idx];
    end
    if (ischar(chksum1_details.ContentsChecksumItems(idx).Value))
            if (~strcmp(chksum1_details.ContentsChecksumItems(idx).Value, ...
                        chksum2_details.ContentsChecksumItems(idx).Value))
            disp(['Character vector values different for contents item ', num2str(idx)]); 
            idxForCDiffs=[idxForCDiffs, idx];
            end
    end
    if (isnumeric(chksum1_details.ContentsChecksumItems(idx).Value))
            if (chksum1_details.ContentsChecksumItems(idx).Value ~= ...
                        chksum2_details.ContentsChecksumItems(idx).Value)
            disp(['Numeric values different for contents item ', num2str(idx)]); 
            idxForCDiffs=[idxForCDiffs, idx];
            end
    end
end

10 Run the script. The example assumes that you named the script check_details.

check_details
Character vector values different for contents item 202

The results indicate that differences exist for index item 202 in the subsystem contents.
11 Use the returned index values to get the handle, identifier, and value details for each difference

found.

chksum1_details.ContentsChecksumItems(202)

ans = 

        Handle: 'rtwdemo_ssreuse/SS1/Lookup Table'
    Identifier: 'SaturateOnIntegerOverflow'
         Value: 'on'

The details identify the Lookup Table block parameter Saturate on integer overflow as the
focus for debugging a subsystem reuse issue.
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Library-Based Code Generation for Reusable Library
Subsystems

Library-based code generation provides a way of generating code for a set of reusable components
that models can share. For each top-level reusable library subsystem, you specify a set of function
interfaces that lock down the subsystem interface. A function interface consists of the subsystem
input and output block parameter settings and the model configuration parameter settings.

Function interfaces are independent models that you save with an accompanying library. Before
generating code for a model containing instances of the reusable library subsystem, you generate
code for the library. Library-based code generation makes the library the owner of the code. To make
the individual models the owner of the code, you can generate code for reusable library subsystems
to the shared utilities folder. For more information, see “Generate Reusable Code from Library
Subsystems Shared Across Models” on page 7-41.

Example Model and Library
To show how to use function interfaces and library-based code generation, this example uses the
model rtwdemo_libcodegen_mdl and library rtwdemo_libcodegen_lib. The model contains two
instances of the reusable library subsystem Atomic_Controller. For
Atomic_Controller_Single, the input signal data type is single. For
Atomic_Controller_Double, the input signal data type is double. To open the model and library
files, at the MATLAB command prompt, enter:

rtwdemo_libcodegen_mdl
rtwdemo_libcodegen_lib
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Configure Reusable Library Subsystems
To perform library-based code generation, you must configure the library subsystem as reusable.

1 In the Subsystem block parameters dialog box, select “Treat as atomic unit”.
2 In the Subsystem block parameters dialog box, on the Code Generation tab, set the “Function

packaging” parameter to Reusable function.

Specify Unique Function Interface Names
Each function interface corresponding to the same reusable library subsystem must have a unique
name. To specify a unique name, follow these steps:

1 In the Subsystem block parameters dialog box, on the Code Generation tab, set the Function
name options parameter to User specified.

2 For the Function name parameter, specify the $R and $N tokens. The $R token represents the
function interface name. The $N token represents the subsystem name.

3 In the Create Function Interface dialog box, for the Name parameter, specify a name that
describes the context.

4 Set the File name option parameter to Auto or Use function name.
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Configure and Manage Function Interfaces
The model rtwdemo_libcodegen_mdl contains two instances of the reusable library subsystem
Atomic_Controller. Each instance represents a function interface. In the library
rtwdemo_libcodegen_lib, right-click the badge at the lower rightmost side of the reusable library
subsystem Atomic_Controller. Select Manage Function Interfaces. The two function interfaces
have the names Single and Double because Atomic_Controller takes single and double data
types.

To create function interfaces, in a library, right-click a subsystem and select C/C++ Function
Interfaces > Create Function Interface. Specify a function interface Name.
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Then, to configure the function interfaces, choose one of the following methods.

Specify a Function Interface from Model

To create function interfaces from linked instances of the reusable library subsystem:

1 In the library, right-click the badge at the lower rightmost side of the reusable library subsystem
and select Create Function Interface. In the dialog box, select the Specify library block
instance to create function interface parameter.

2 For the Simulink model with instance parameter, select the model that contains the
subsystem.

3 For the Library block instance name parameter, select the subsystem.
4 Click OK and close the Create Function Interface dialog box.
5 For each function interface, repeat the preceding steps.

Note You can create a function interface from within a model that contains an instance of a linked
reusable library subsystem. You must be in the Code perspective. To open the Code perspective, from
the apps menu, select Embedded Coder. If the subsystem has function interfaces, a badge appears
at the lower-right corner of the subsystem. Right-click the badge and select Create Function
Interface. If the subsystem does not have function interfaces, right-click the subsystem, and select
C/C++ Function Interfaces > Create Function Interface.
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Export and Configure an Existing Function Interface

To export and configure the function interface as an independent model:

1 In the library, right-click the badge at the lower rightmost side of the reusable library subsystem
and select Manage Function Interfaces.

2 Select the function interfaces that you want to modify.
3 Click Export.
4 In the Save As window, specify the current working folder. An exported function interface is

a .slx file that has the function interface name plus the appendix _export.
5 Open the exported model. Make your changes to the subsystem input and output block

parameter settings and model configuration parameter settings. Save the model.
6 In the library, right-click the reusable library subsystem and select C/C++ Function Interfaces

> Create Function Interface. Specify a function interface Name.
7 For the Simulink model with instance parameter, select the exported model that is in the

current working folder.
8 For the Library block instance name parameter, select the subsystem.
9 Click OK and close the Create Function Interface dialog box.

Configure Function Interfaces from Within a Library

1 In the library, right-click the badge at the lower rightmost side of the subsystem and select
Configure Function Interface.

2 In the Configure Function Interface dialog box, for the subsystem inputs and outputs, specify
values for the Data Type, Dimensions, and Signal Type parameters. To modify other subsystem
input and output parameter settings, follow the export method in the preceding section.

8 Library-Based Code Generation

8-6



3 To modify the model configuration parameters, click the gear button and make the changes. Click
Apply. Close the Configuration Parameters dialog box.

4 To replace a function interface with an existing one from an instance model, select Regenerate
Using Instance.

5 Specify values for the Simulink model with instance and Library block instance name
parameters. Click Regenerate.

6 Click Apply and close the Configure Function Interface dialog box.

Build the Library
After you specify function interfaces for the subsystems in your library, generate code for the library.
Before generating code for your model, you must generate code for the library. The code generator
packages the library code as a separate C library. The generated code for the library is in a folder
corresponding to your hardware settings (for example, IntelWin64). The library code folder has the
same name as the library and must be at the same hierarchical level as the library.

To generate code, check that the library is unlocked. Open the Embedded Coder app and click
Build Library.

When you generate code for the rtwdemo_libcodegen_lib library, the
rtwdemo_libcodegen_lib folder contains these .c and .h files:

• Atomic_Controller_Single.h
• Atomic_Controller_Single.c
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• Atomic_Controller_Double.h
• Atomic_Controller_Double.c

These functions names are representative of the $N$R specification for the Function name options
and Function name parameters on the Subsystem block parameters dialog box.

A _shared folder contains code for shared utilities (for example, fixed-point utilities and Lookup
Table and MATLAB function blocks), supplementary files, and exported parameters and types.

When you generate code for a model that contains an instance of a reusable library subsystem that
can use the pregenerated library code, the model links to the library code. The code generator uses a
checksum to determine reusability. The generated code for the model must be in the same folder as
the library. At the MATLAB command line, enter:

Simulink.fileGenControl('set', 'CodeGenFolderStructure',...
 Simulink.filegen.CodeGenFolderStructure.TargetEnvironmentSubfolder);

For more information, see Simulink.fileGenControl.

If the model is unable to use the library code, you can specify whether or not Embedded Coder
produces a warning or an error during code generation. In the Configuration Parameters dialog box,
set the Behavior when pregenerated library subsystem code is missing diagnostic parameter
setting.

You can generate code for a library but not execute a makefile by entering these commands:

library='rtwdemo_libcodegen_lib'
set_param(library, 'GenCodeOnly', 'on')
slbuild(library)

Note You can generate code for a library consisting of reusable subsystems that contain S-functions.
To avoid uncompilable code, in the TLC function corresponding to the S-function, avoid directing the
code generator to interact with model files, such as model.c, model.h, and model_types.h.

Generate Code from Model Containing a Reusable Library Subsystem
Instance
To generate code from a model that contains an instance of a reusable library subsystem for which
you want to use the library code:

1 Set the model configuration parameter Shared code placement to Shared location.
2 Specify a setting for the “Behavior when pregenerated library subsystem code is missing”

parameter or leave the default setting, which is warning.
3 In the Configuration Parameters dialog box, the parameter settings on the Code Generation

panes must all be identical to each other. If the settings are different, you might get a warning,
error, or neither depending on the setting of the Behavior when pregenerated library
subsystem code is missing parameter.

4 If a reusable library subsystem uses a shared local data store and you configure default mapping
for model data elements, leave the default storage class mapping for category Shared local
data stores set to Default.

Here is the generated C code for rtwdemo_libcodegen_mdl.
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/* Model step function */
void rtwdemo_libcodegen_mdl_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/Atomic_Controller_Double' */

  /* Inport: '<Root>/pos_rqst' incorporates:
   *  Inport: '<Root>/fbk_1'
   *  Outport: '<Root>/pos_cmd_one'
   */
  Atomic_Controller_Double(pos_rqst1, rtU.fbk_1, &rtY.pos_cmd_one,
    &rtDW.Atomic_Controller_Double);

  /* End of Outputs for SubSystem: '<Root>/Atomic_Controller_Double' */

  /* Outputs for Atomic SubSystem: '<Root>/Atomic_Controller_Single' */

  /* Inport: '<Root>/pos_rqst1' incorporates:
   *  Inport: '<Root>/fbk_2'
   *  Outport: '<Root>/pos_cmd_two'
   */
  Atomic_Controller_Single(pos_rqst2, rtU.fbk_2, &rtY.pos_cmd_two,
    &rtDW.Atomic_Controller_Single);

  /* End of Outputs for SubSystem: '<Root>/Atomic_Controller_Single' */
}

The code contains calls to the Atomic_Controller_Single and Atomic_Controller_Double
functions. The generated code pulls the function definitions from the pregenerated library code.

Verify Code Generated from Reusable Library Subsystems
Verification Workflow

If you have Simulink Test software, you can verify code that you generate from reusable library
subsystems. Use this workflow:

1 Create a test harness in a library for a unique subsystem and function interface pair.
2 With the SIL/PIL Manager:

a Run normal mode and software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulations of
the subsystem.

b Compare numerical results in the Simulation Data Inspector.
c View the Simulink Coverage analysis report.

For more information, see “Test Library Blocks” (Simulink Test).

Verification Workflow Limitations

The verification workflow does not support:

• Function-Call Subsystem blocks.
• Triggered Subsystem blocks or subsystems that use zero-crossing events.
• Function interfaces where the number of Inports/Outports does not match the number of Inports/

Outports in the graphical interface.
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• Parameters that use the ExportToFile storage class.
• Subsystems with Outport blocks that are fed by Mux or Demux blocks.
• Virtual buses that are passed as Inport blocks.
• Data Store Memory blocks that use the ExportedGlobal storage class.
• Blocks where data is initialized outside the subsystem code, for example, the Width block.
• Code coverage highlighting and annotation.
• Signal and state data logging.

For such cases, you can create a model that contains an instance of the reusable library subsystem
and use the SIL/PIL Manager to run SIL or PIL simulations.

Limitations
Because the code generator uses a checksum to determine reusability, the same limitations that apply
to generating code for models that share reusable library subsystems apply to library-based code
generation. See “Limitations” on page 7-38. These limitations also apply:

• You cannot specify a function interface on a reusable library subsystem that is within another
reusable library subsystem.

• Only ERT and ERT-derived system target files support library-based code generation.
• Each function interface that corresponds to the same reusable library subsystem must be unique.
• On Windows platform, avoid naming the library lib.slx as doing so may interfere with the static

library compilation process.
• When you generate code from a library, the code generator only generates code for top-level

reusable subsystems in the library. The top-level library subsystem can be instantiated at any level
in a client model and the instance in the client model reuses library code if it finds any.

• A library subsystem cannot reuse code if it is inside an Enabled Subsystem block with the Enable
block parameter, States when enabling, set to reset.

See Also

More About
• “Generate Reentrant Code from Subsystems” on page 7-33
• “Generate Reusable Code from Library Subsystems Shared Across Models” on page 7-41
• “Determine Why Subsystem Code Is Not Reused” on page 7-71
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• “Configure Run-Time Environment Options” on page 9-2
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Configure Run-Time Environment Options
When you use Simulink software to create and execute a model and use the code generator to
produce C or C++ code, consider your configuration for up to three run-time environments:

• The MATLAB development computer run-time environment that runs MathWorks software during
application development.

• The production hardware run-time environment in which you deploy an application when it is put
into production.

• The test hardware run-time environment in which you test an application under development
before deployment.

One run-time environment can serve in multiple capacities, but the run-time environments remain
conceptually distinct. Often, the MATLAB development computer is the test hardware. Typically, the
production hardware is different from, and less powerful than, the MATLAB development or the test
hardware. Many types of production hardware can do little more than run a downloaded executable
file.

Provide information about the production hardware board and the compiler that you use with it
when:

• You use Simulink software to simulate a model for which you later generate code
• You use the code generator to produce code for deployment on production hardware

The software uses the board and compiler information to get bit-true agreement for the results of
integer and fixed-point operations performed in simulation and in code generated for the production
hardware. The code generator uses the information to create code that executes with maximum
efficiency.

When you generate code for testing on test hardware, provide information about the test hardware
board and the compiler that you use. The code generator uses this information to create code that
provides bit-true agreement between results from:

• Integer and fixed-point operations performed in simulation
• Generated code run on the production hardware
• Generated code run on the test hardware

You can achieve bit-true agreement for results even if the production and test hardware are different.
Where the C standard does not completely define behavior, the compilers for the two types of
hardware can use different defaults.

Configure Production and Test Hardware
You can specify model simulation or code generation for a specific hardware board and its device
type. For example, you can set the data size, byte ordering, and compiler behavior, such as integer
rounding. You can configure:

• The production hardware and the compiler that you use with it. This information affects simulation
and code generation. See “Example Production Hardware Setting That Affects Normal Mode
Simulation” on page 9-8.

• The test hardware and the compiler that you use with it. This information affects only code
generation.
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Configure production hardware by selecting Configuration Parameters > Hardware
Implementation. By default, the Hardware Implementation pane lists Hardware board, Device
vendor, and Device type parameter fields only. Unless you have installed hardware support
packages, Hardware board lists values None or Determine by Code Generation system
target file, and Get Hardware Support Packages. After installing a hardware support
package, the list also includes the corresponding hardware board name. If you select a hardware
board name, parameters for that board appear. To set device details, such as data size and byte
ordering, click Device details.

Configure test hardware on the Configuration Parameters > Hardware Implementation >
Advanced parameters pane. To enable parameters for configuring test hardware details, disable the
Configuration Parameters > Hardware Implementation > Advanced parameters > Test
hardware is the same as production hardware parameter. Code generated for test hardware
executes in the environment specified by the test hardware parameters. The code behaves as if it
were executing in the environment specified for the production hardware. For more information, see
“Test Hardware Considerations” on page 9-8.

Default values and properties appear as initial values in the Hardware Implementation pane when:

• You specify a System target file in the Code Generation pane.
• The system target file specifies a default microprocessor and its hardware properties.

You cannot change parameters that have only one possible value. Parameters that have more than
one possible value provide a list of valid values. If you specify hardware properties manually in
Hardware Implementation pane, verify that these values are consistent with the system target file.
Otherwise, the generated code can fail to compile or execute, or can execute but produce incorrect
results.

Hardware implementation parameters describe hardware and compiler properties to MATLAB
software. The code generator uses the information to produce code for the run-time environment that
runs as efficiently as possible. The generated code gives bit-true agreement for the results of integer
and fixed-point operations in simulation, production code, and test code.

For details about specific parameters, see “Hardware Implementation Pane”. To see an example of
Hardware Implementation pane capabilities, see the rtwdemo_targetsettings example model.
For details related to configuring a hardware implementation, see:

• “Specify Hardware Board” on page 9-3
• “Specify Device Vendor” on page 9-4
• “Specify the Device Type” on page 9-4
• “Set Bit Lengths for Device Data Types” on page 9-5
• “Set Byte Ordering for Device” on page 9-5
• “Set Quotient Rounding Behavior for Signed Integer Division” on page 9-6
• “Set Arithmetic Right Shift Behavior for Signed Integers” on page 9-6
• “Update Release 14 Hardware Configuration” on page 9-7

Specify Hardware Board

Specify the hardware board that runs the code generated from your model. Select a value for
Configuration Parameters > Hardware Implementation > Hardware board.
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The Hardware Implementation pane identifies the system target file selected on Configuration
Parameters > Code Generation.

To configure test hardware, use the Configuration Parameters > Hardware Implementation >
Advanced parameters pane.

To enable parameters for configuring test hardware details, set ProdEqTarget to off.

Ways to Specify the Hardware Board

If Select
The menu includes the name of the hardware
board that you want to use.

The name of that hardware board.

If you select a hardware board name, parameters for
that board appear.

The menu does not include the name of the
hardware board that you want to use.

Get Hardware Support Packages.

That value opens the Support Package Installer. Install
the support package that you want. After you install
the support package, the menu includes relevant
hardware board names.

The model configuration uses system target
file ert.tlc, realtime.tlc, or
autosar.tlc.

None.

No hardware board is specified for the hardware
implementation.

The model configuration does not use system
target file ert.tlc, realtime.tlc, or
autosar.tlc.

Determine by Code Generation system target
file.

The code generator uses the specified system target
file to determine the hardware implementation.

Specify Device Vendor

To specify the vendor of the microprocessor of the hardware device, use the Device vendor
parameter. Your selection determines the available microprocessors in the Device type menu. If the
vendor name does not appear, select Custom Processor. Then, use the Device type parameter to
specify the microprocessor.

• For complete lists of Device vendor and Device type values, see “Device vendor” and “Device
type”.

• To add Device vendor and Device type values to the default set that is displayed on the
Hardware Implementation pane, see “Register New Hardware Devices” on page 9-11.

Specify the Device Type

To specify the microprocessor name from the supported devices listed for your Device vendor
selection, use the Device type parameter. If the microprocessor does not appear in the menu, change
Device vendor to Custom Processor. Then, specify device details for your custom device.

If you select a device type for which the system target file specifies default hardware properties, the
properties appear as initial values. You cannot change the value of parameters with only one possible
selection. Parameters that have more than one possible value provide a menu. Select values for your
hardware.
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Set Bit Lengths for Device Data Types

The Number of bits parameters describe the native word size of the microprocessor and the bit
lengths of char, short, int, and long data. For code generation to succeed:

• The bit lengths must be such that char <= short <= int <= long.
• Bit lengths must be multiples of 8, with a maximum of 32.
• The bit length for long data must not be less than 32.

The rtwtypes.h file defines integer type names. The values that you provide must be consistent
with the word sizes as defined in the compiler limits.h header file. The code generator maps its
integer type names to the corresponding Simulink integer type names.

If no ANSI® C type with a matching word size is available, but a larger ANSI C type is available, the
code generator uses the larger type for int8_T, uint8_T, int16_T, uint16_T, int32_T, and
uint32_T. When the code generator uses a larger type, the resulting logged values (for example,
MAT-file logging) can have different data types than logged values for simulation.

An application can use an integer data of length from 1 (unsigned) or 2 (signed) bits up 32 bits. If the
integer length matches the length of an available type, the code generator uses that type. If a
matching type is not available, the code generator uses the smallest available type that can hold the
data, generating code that does not use unnecessary higher-order bits. For example, on hardware
that supports 8-bit, 16-bit, and 32-bit integers, for a signal specified as 24 bits, the code generator
implements the data as an int32_T or uint32_T.

Code that uses emulated integer data is not maximally efficient. This code can be useful during
application development for emulating integer lengths that are available only on production
hardware. Emulation does not affect the results of execution.

During code generation, the software checks the compatibility of model data types with the data
types that you specify for production hardware.

• If none of the lengths that you specify for production hardware integers is 32 bits, the software
generates an error.

• If the lengths of data types that the model uses are smaller than the available production
hardware integer lengths, the software generates a warning.

Mapping of Integer Types from Code Generator to Simulink
Code Generator Integer Type Simulink Integer Type
boolean_T boolean
int8_T int8
uint8_T uint8
int16_T int16
uint16_T uint16
int32_T int32
uint32_T uint32

Set Byte Ordering for Device

The Byte ordering parameter specifies whether the hardware uses Big Endian (most significant
byte first) or Little Endian (least significant byte first) byte ordering. If left as Unspecified, the
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code generator produces code that determines the endianness of the hardware. This setting is the
least efficient.

Set Quotient Rounding Behavior for Signed Integer Division

ANSI C does not completely define the quotient rounding technique for compilers to use when
dividing one signed integer by another. So, the behavior is implementation-dependent. If both
integers are positive, or both are negative, the quotient must round down. If either integer is positive
and the other is negative, the quotient can round up or down.

The Signed integer division rounds to parameter instructs the code generator about how the
compiler rounds the result of signed integer division. Providing this information does not change the
operation of the compiler. It only describes that behavior to the code generator, which uses the
information to optimize code generated for signed integer division. The parameter values are:

• Zero — If the quotient is between two integers, the compiler chooses the integer that is closer to
zero as the result.

• Floor — If the quotient is between two integers, the compiler chooses the integer that is closer to
negative infinity.

• Undefined — If Zero or Floor do not describe the compiler behavior or if that behavior is
unknown, choose this value.

Avoid selecting Undefined. When the code generator does not know the signed integer division
rounding behavior of the compiler, the model build generates extra code.

The compiler quotient rounding behavior varies according to these values.

You can obtain the compiler implementation for signed integer division rounding from the compiler
documentation. If documentation is not available, you can determine this behavior by experiment.

Example Quotient Rounding for Zero, Floor, and Undefined

N D Ideal N/D Zero Floor Undefined
33 4 8.25 8 8 8
-33 4 -8.25 -8 -9 -8 or -9
33 -4 -8.25 -8 -9 -8 or -9
-33 -4 8.25 8 8 8 or 9

Set Arithmetic Right Shift Behavior for Signed Integers

ANSI C does not define the behavior of right shifts on negative integers for compilers. So, the
behavior is implementation-dependent. The Shift right on a signed integer as arithmetic shift
option instructs the code generator about how the compiler implements right shifts on negative
integers. Providing this information does not change the operation of the compiler. It only describes
that behavior to the code generator, which uses the information to optimize the code generated for
arithmetic right shifts.

If the C compiler implements a signed integer right shift as an arithmetic right shift, select the
option. Otherwise, clear the option. An arithmetic right shift fills bits vacated by the right shift with
the value of the most significant bit, which indicates the sign of the number in two’s-complement
notation. The option is selected by default. If your compiler handles right shifts as arithmetic shifts,
this setting is preferred.
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• When you select the option, the code generator produces efficient code whenever the Simulink
model performs arithmetic shifts on signed integers.

• When the option is cleared, the code generator produces fully portable but less efficient code to
implement right arithmetic shifts.

You can obtain the compiler implementation for arithmetic right shifts from the compiler
documentation. If documentation is not available, you can determine this behavior by experiment.

Update Release 14 Hardware Configuration

If your model was created before Release 14 and you have not updated the model, the Configure
current execution hardware device parameter (TargetUnknown) value is 'on' by default.

To update your model, clear the box for Configuration Parameters > Hardware Implementation
> Advanced parameters > Test hardware > Configure test hardware.Or in the Command
Window, type:
cs = getActiveConfigSet('your_model_name');
set_param(cs,'TargetUnknown','off');

This update to your model:

• Enables the Test Hardware is the same as production hardware parameter (ProdEqTarget),
setting the parameter to 'on'.

• Copies the Production device vendor and type parameter (ProdHWDeviceType) value to the
Test device vendor and type parameter (TargetHWDeviceType).

To complete the update:

1 Clear the box for Configuration Parameters > Hardware Implementation > Advanced
parameters > Test hardware > Test Hardware is the same as production hardware. Apply
this step only if your production and test hardware are different.

2 Set the parameters in Configuration Parameters > Hardware implementation > Advanced
parameters to match your production and test systems.

3 Save the model.

Production Hardware Considerations
When you configure production hardware, consider these points:

• Production hardware can have word sizes and other hardware characteristics that differ from the
MATLAB development computer. You can prototype code on hardware that is different from the
production hardware or the MATLAB development computer. When producing code, the code
generator accounts for these differences.

• The Simulink product uses some of the information in the production hardware configuration.
That information enables simulations without code generation to give the same results as
executing generated code. For example, the results can detect error conditions that arise on the
production hardware, such as hardware overflow.

• The code generator produces code that provides bit-true agreement with Simulink results for
integer and fixed-point operations. Generated code that emulates unavailable data lengths runs
less efficiently than without emulation. The emulation does not affect bit-true agreement with
Simulink for integer and fixed-point results.
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• If you change run-time environments during application development, before generating or
regenerating code, reconfigure the hardware implementation parameters for the new run-time
environment. When code executes on hardware for which it was not generated, bit-true
agreement is not always achieved for results of integer and fixed-point operations in simulation,
production code, and test code.

• To compile code generated from the model, use the Integer rounding mode parameter on model
blocks to simulate the rounding behavior of the C compiler that you intend. This setting appears
on the Signal Attributes pane in the parameter dialog boxes of blocks that can perform signed
integer arithmetic, such as the Product and n-D Lookup Table blocks.

• For most blocks, the value of Integer rounding mode completely defines rounding behavior. For
blocks that support fixed-point data and the simplest rounding mode, the value of Signed integer
division rounds to also affects rounding. For details, see “Precision” (Fixed-Point Designer).

• When models contain Model blocks, configure models that they reference to use identical
hardware settings.

Test Hardware Considerations
By default, the test hardware configuration is the same as the configuration for the production
hardware. You can use the generated code for testing in an environment that is identical to the
production environment.

If the test and production environments differ, you can generate code that runs on test hardware as if
it were running on production hardware:

1 To enable test hardware parameters, clear the box for Configuration Parameters > Hardware
Implementation > Advanced parameters > Test hardware > Test hardware is the same as
production hardware. Or, in the Command Window type:
cs = getActiveConfigSet('your_model_name');
set_param(cs,'ProdEqTarget','off');

2 Specify device type details through the test hardware (Target*) parameters.

If you select a system target file that specifies a default microprocessor and its hardware properties,
these default values and properties appear as initial values.

Parameters with only one possible value cannot be changed. If you modify hardware properties,
check that their values are consistent with the system target file. Otherwise, the generated code can
fail to compile or execute, or can execute but produce incorrect results.

Example Production Hardware Setting That Affects Normal Mode
Simulation
Changing some production hardware settings, for example, ProdLongLongMode and
ProdIntDivRoundTo, can affect normal mode simulation results. The following example simulates
an adder with four inputs. In the first simulation, ProdLongLongMode is disabled. In the second
simulation, ProdLongLongMode is enabled. In the plot of simulation outputs, you observe small
differences between output values in the time step range 125–175.
model = 'hwSettingEffect';
new_system(model) 
open_system(model)

% Create adder
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pos = [140   140   200   340];
add_block('simulink/Math Operations/Add', ...
          [model '/sum_int32'], ...
          'Inputs','++++', ...
          'SaturateOnIntegerOverflow', ...
          'on', ...
          'Position', ...
          pos)

pos = [75   155   105   175];
add_block('built-in/Inport',[model '/In1'],'Position',pos)
set_param([model '/In1'], 'OutDataTypeStr', ...
          'int32','PortDimensions','1','SampleTime','1');
add_line(model, 'In1/1','sum_int32/1')

pos = [75   205   105   225];
add_block('built-in/Inport',[model '/In2'],'Position',pos)
set_param([model '/In2'], 'OutDataTypeStr', ...
           'int32','PortDimensions','1','SampleTime','1');
add_line(model, 'In2/1','sum_int32/2')

pos = [75   255   105   275];
add_block('built-in/Inport',[model '/In3'],'Position',pos)
set_param([model '/In3'], 'OutDataTypeStr', ...
          'int32','PortDimensions','1','SampleTime','1');
add_line(model, 'In3/1','sum_int32/3')

pos = [75   305   105   325];
add_block('built-in/Inport',[model '/In4'],'Position',pos)
set_param([model '/In4'], 'OutDataTypeStr', ...
           'int32','PortDimensions','1','SampleTime','1');
add_line(model, 'In4/1','sum_int32/4')

pos = [275   230   305   250];
add_block('built-in/Outport',[model '/Out1'],'Position',pos)
add_line(model, 'sum_int32/1','Out1/1')

% Specify input data
t = 0:200;
peakValue = 1.5e9;
in1 = peakValue * sin(t*2*pi/100);
in2 = peakValue * cos(t*2*pi/70);
in3 = -peakValue * sin(t*2*pi/40);
in4 = -peakValue * cos(t*2*pi/30);
set = Simulink.SimulationData.Dataset;
set = set.addElement(1, timeseries(int32(in1),t,'Name','sig1'));
set = set.addElement(2, timeseries(int32(in2),t,'Name','sig2'));
set = set.addElement(3, timeseries(int32(in3),t,'Name','sig3'));
set = set.addElement(4, timeseries(int32(in4),t,'Name','sig4'));

set_param(model, 'LoadExternalInput', 'on');
set_param(model, 'ExternalInput', 'set');

set_param(model, 'StopTime', '50');

% Disable production hardware setting and run first simulation
set_param(model, 'ProdLongLongMode', 'off');
[~, ~, y1] = sim(model, 200);

% Enable production hardware setting and run second simulation
set_param(model, 'ProdLongLongMode', 'on');
[~, ~, y2] = sim(model, 200);

plot([y1 y2]);
figure(gcf);

The difference in behavior is due to the accumulator data type in the Sum block. The Accumulator
data type block parameter is set to Inherit: Inherit via internal rule. For this example,
the resulting accumulator data type is 64 bits wide if the use of the C long long data type is
enabled. Otherwise, it is 32 bits wide. Depending on the input values for the sum block, the 32-bit
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accumulator can saturate when the 64-bit accumulator does not. Therefore, normal mode behavior
can depend on the ProdLongLongMode setting. In both cases, the normal mode behavior and
production hardware behavior matches bitwise.

See Also

More About
• “Hardware Implementation Pane”
• “Device vendor”
• “Device type”
• “Precision” (Fixed-Point Designer)
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Register New Hardware Devices
On the Hardware Implementation pane, you can specify parameters that describe target hardware
and compiler properties for MATLAB software, which enables you to:

• Observe target hardware during model simulations.
• Generate optimized code for production or test hardware.
• Directly test or deploy generated code on target hardware.

The Hardware Implementation pane supports a range of target hardware. To extend the range,
register new hardware devices by using the target.Processor and
target.LanguageImplementation classes.

Specify Hardware Implementation for New Device
To register a new hardware device:

1 Create a target.Processor object for the new hardware device.
myProc = target.create('Processor', ...
                       'Name', 'MyProcessor', ...
                       'Manufacturer', 'MyManufacturer');

2 Create a target.LanguageImplementation object for language implementation details.
myLanguageImplementation = target.create('LanguageImplementation', ...
                                         'Name', 'MyProcessorImplementation');

3 Specify language implementation details.
myLanguageImplementation.Endianess = target.Endianess.Little;
 
myLanguageImplementation.AtomicIntegerSize = 64;
myLanguageImplementation.AtomicFloatSize = 64;
myLanguageImplementation.WordSize = 64;
 
myLanguageImplementation.DataTypes.Char.Size = 8;
myLanguageImplementation.DataTypes.Short.Size = 16;
myLanguageImplementation.DataTypes.Int.Size = 32;
myLanguageImplementation.DataTypes.Long.Size = 64;
myLanguageImplementation.DataTypes.LongLong.IsSupported = true;
myLanguageImplementation.DataTypes.LongLong.Size = 64;
myLanguageImplementation.DataTypes.Float.Size = 32;
myLanguageImplementation.DataTypes.Double.Size = 64;
 
myLanguageImplementation.DataTypes.Pointer.Size = 32;
  
myLanguageImplementation.DataTypes.SizeT.Size = 64;
myLanguageImplementation.DataTypes.PtrDiffT.Size = 64;

4 Associate the language implementation with the hardware device.
myProc.LanguageImplementations = myLanguageImplementation;

5 Add the target.Processor object to an internal database.
objectsAdded = target.add(myProc);

On the Hardware Implementation pane, you can now set Device vendor and Device type to
MyManufacturer and MyProcessor respectively.
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Specify Hardware Implementation That Persists Over MATLAB
Sessions
By default, when you add the target object to the internal database, the target data is available only
for the current MATLAB session. You can specify target data persistence over MATLAB sessions.

1 Create a target.Processor object for a new hardware device.

myProc = target.create('Processor', ...
                       'Name', 'MyProcessor', ...
                       'Manufacturer', 'MyManufacturer');

existingImplementation = target.get('LanguageImplementation', ... 
                                    'ARM Compatible-ARM Cortex'); 
myProc.LanguageImplementations = existingImplementation;

2 Add the target.Processor object to an internal database and specify persistence of target
data over MATLAB sessions.

objectsAdded = target.add(myProc, 'UserInstall', true);
3 You can remove the object from the internal database.

target.remove(objectsAdded);

Create Hardware Implementation by Modifying Existing
Implementation
If an existing hardware implementation contains most of the values that you want in a new hardware
implementation, you can quickly create the new implementation by creating and modifying a copy of
the existing implementation.

1 Create a target.Processor object for the new hardware device.
myProc = target.create('Processor', ...
                       'Name', 'MyProcessor', ...
                       'Manufacturer', 'MyManufacturer');

2 Create a target.LanguageImplementation object that copies an existing language
implementation.
myCopiedImplementation = target.create('LanguageImplementation', ...
                                       'Name', 'MyCopiedImplementation', ...
                                       'Copy', 'Atmel-AVR');

3 Specify the required language implementation details. For example, byte ordering.
myCopiedImplementation.Endianess = target.Endianess.Big;

4 Associate the language implementation with the hardware device.
myProc.LanguageImplementations = myCopiedImplementation;

5 Add the target.Processor object to an internal database.
objectsAdded = target.add(myProc);

Create Hardware Implementation by Reusing Existing Implementation
If your hardware device requires the same hardware implementation as an existing implementation,
you can reuse the existing implementation.

1 Create a target.Processor object for the new hardware device.
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myProc = target.create('Processor', ...
                       'Name', 'MyProcessor', ...
                       'Manufacturer', 'MyManufacturer');

2 Retrieve the existing implementation by using the identifier for the device vendor and type, for
example, 'ARM Compatible-ARM Cortex'.

existingImplementation = target.get('LanguageImplementation', ...
                                    'ARM Compatible-ARM Cortex');

3 Associate the language implementation with the hardware device.

myProc.LanguageImplementations = existingImplementation;
4 Add the target.Processor object to an internal database.

objectsAdded = target.add(myProc);

Validate Hardware Device Data
To validate the data integrity of target objects, use the IsValid property or validate method of the
target.Object base class.

Consider an example where you create a target.Processor object and associate an existing
language implementation with the object.
myProcessor = target.create('Processor');
myProcessor.LanguageImplementations = target.get('LanguageImplementation', ...
                                                 'ARM Compatible-ARM Cortex');

To validate the created object, run myProcessor.IsValid or myProcessor.validate().
myProcessor.IsValid

ans =
  logical
  0

myProcessor.validate()

Error using target.Processor/validate
Target data validation failed.
* Undefined property "Name" in "Processor" object.
* Undefined identifier in "Processor" object.

The validation fails because these target.Processor properties are not specified:

• Name — Processor name
• Id — Object identifier

You can specify a processor name, which also specifies the object identifier.
myProcessor.Name = 'MyProcessor';

Check the validity of myProcessor.
myProcessor.IsValid

ans =
  logical
  1

The validity of the object is established.
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Note When you use the target.add function to register a target object, the software also checks
the validity of the object.

Export Hardware Device Data
You can share previously created hardware device data across computers and users.

For this example, specify a hardware device and add it to an internal database.
myProc = target.create('Processor', ...
                    'Name', 'MyProcessor', ...
                    'Manufacturer', 'MyManufacturer');
existingImplementation = target.get('LanguageImplementation', ...
                                 'ARM Compatible-ARM Cortex');
myProc.LanguageImplementations = existingImplementation;

objectsAdded = target.add(myProc);

To create a function for sharing the hardware device data, run:
target.export(myProc, 'FileName', 'exportMyProcFunction')

The target.export function creates exportMyProcFunction.m in the current working folder.
function registeredObjects = exportMyProcFunction(varargin)
% This function was generated using target data export.

    % Create target.Processor "MyManufacturer-MyProcessor"
    processor = target.create("Processor");
    processor.LanguageImplementations(1) = ...
      target.get("LanguageImplementation", "ARM Compatible-ARM Cortex");
    processor.Manufacturer = "MyManufacturer";
    processor.Name = "MyProcessor";

    % Add the target objects to MATLAB memory
    registeredObjects = target.add(processor, varargin{:});

Now, you can use the generated function to share the hardware device data in your database across
computers and users. For example, on another computer, run this command.
objectsAdded = exportMyProcFunction;

The generated function recreates the target.Processor object, MyManufacturer-MyProcessor,
and adds it to an internal database.

Create Alternative Identifier for Target Object
To create alternative identifiers for target objects, use the target.Alias class.

For example, if a target.Processor object has a long class identifier, you can create a
target.Alias object that provides a short identifier for the target.Processor object.

1 Retrieve the target.Processor object.

proccesorObj = target.get('Processor', ...
                          'Analog Devices-ADSP-CM40x (ARM Cortex-M)');

2 Use the target.create function to create a target.Alias object.

aliasProcessorObj = target.create('Alias');
3 Use target.Alias object properties to specify the alternative identifier and original target

object.
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aliasProcessorObj.Name = 'myShortName';
aliasProcessorObj.For = proccesorObj;

4 Add the target.Alias object to an internal database.

target.add(aliasProcessorObj);
5 To retrieve the original target.Processor object, run:

target.get('Processor', 'myShortName');

Upgrade Data Definitions for Hardware Devices
To upgrade existing hardware device definitions that are specified through rtwTargetInfo.m or
sl_customization.m files, use the target.upgrade function.

rtwTargetInfo.m File

Suppose you have the hardware device definition in an rtwTargetInfo.m file:
function rtwTargetInfo(tr)
  
    % Add registration function handle to the Target Registry
    tr.registerTargetInfo(@loc_register_hardware);
end
  
function hw = loc_register_hardware
    hw = RTW.HWDeviceRegistry;
    hw.Vendor = 'MyManufacturer';
    hw.Type = 'MyDevice';
    hw.Alias = {};
    hw.Platform = {'Prod', 'Target'};
    hw.setWordSizes([8 16 32 64 64 64 64 64 64 64 64]);
    hw.Endianess = 'Little';
    hw.IntDivRoundTo = 'Zero';
    hw.ShiftRightIntArith = true;
    hw.LargestAtomicInteger = 'Long';
    hw.LargestAtomicFloat = 'Double';
end

To upgrade the data definitions contained in the file, run:
target.upgrade('rtwTargetInfo', 'myPathTo/rtwTargetInfo.m');

In the current folder, the function creates this registerUpgradedTargets.m file:
function processor = registerUpgradedTargets(varargin)
% This function was generated using target data export.
  
    % Create target.LanguageImplementation 'MyManufacturer-MyDevice'
    languageimplementation = target.create('LanguageImplementation');
    languageimplementation.AtomicFloatSize = 64;
    languageimplementation.AtomicIntegerSize = 64;
    languageimplementation.DataTypes.Char.Size = 8;
    languageimplementation.DataTypes.Double.Size = 64;
    languageimplementation.DataTypes.Float.Size = 64;
    languageimplementation.DataTypes.Half.IsSupported = false;
    languageimplementation.DataTypes.Half.Size = 16;
    languageimplementation.DataTypes.Int.Size = 32;
    languageimplementation.DataTypes.Long.Size = 64;
    languageimplementation.DataTypes.LongLong.IsSupported = false;
    languageimplementation.DataTypes.LongLong.Size = 64;
    languageimplementation.DataTypes.Pointer.Size = 64;
    languageimplementation.DataTypes.PtrDiffT.Size = 64;
    languageimplementation.DataTypes.Short.Size = 16;
    languageimplementation.DataTypes.SizeT.Size = 64;
    languageimplementation.Name = 'MyManufacturer-MyDevice';
    languageimplementation.WordSize = 64;
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    % Create target.Processor 'MyManufacturer-MyDevice'
    processor = target.create('Processor');
    processor.LanguageImplementations(1) = languageimplementation;
    processor.Manufacturer = 'MyManufacturer';
    processor.Name = 'MyDevice';
  
    % Add the target objects to MATLAB memory
    target.add(processor, varargin{:});
end

To register the hardware device with MATLAB, run:
registerUpgradedTargets()

If you want the registration to persist across MATLAB sessions, run:
registerUpgradedTargets('UserInstall', true)

sl_customization.m File

Suppose you have multiple hardware device definitions in an sl_customization.m file:
function sl_customization(cm)
  % sl_customization function to register a device
  % vendor and type with Simulink.
  % Copy or rename this file to sl_customization.m.
  cm.registerTargetInfo(@loc_register_device);
  cm.registerTargetInfo(@loc_register_device2);
  cm.registerTargetInfo(@loc_createConfig);
     
  cm.registerTargetInfo(@locRegisterTfl);
  cm.CodeCoverageTools.add('DummyCoverageToolForTesting',...
                           'HDummyCovTool',...
                           'A Coverage Tool Vendor');
end
 
function thisDev = loc_register_device
  thisDev = RTW.HWDeviceRegistry;
  thisDev.Vendor = 'MyDevVendor';
  thisDev.Type = 'MyDevType';
  thisDev.Alias = {};
  thisDev.Platform = {'Prod', 'Target'};
  thisDev.setWordSizes([8 16 32 32 32]);
  thisDev.LargestAtomicInteger = 'Char';
  thisDev.LargestAtomicFloat = 'None';
  thisDev.Endianess = 'Unspecified';
  thisDev.IntDivRoundTo = 'Undefined';
  thisDev.ShiftRightIntArith = true;
  thisDev.setEnabled({'IntDivRoundTo'});
end
 
function thisDev = loc_register_device2
  thisDev = RTW.HWDeviceRegistry;
  thisDev.Vendor = 'MyDevVendor';
  thisDev.Type = 'MyDevType2';
  thisDev.Alias = {};
  thisDev.Platform = {'Prod', 'Target'};
  thisDev.setWordSizes([8 16 32 32 32]);
  thisDev.LargestAtomicInteger = 'Char';
  thisDev.LargestAtomicFloat = 'None';
  thisDev.Endianess = 'Unspecified';
  thisDev.IntDivRoundTo = 'Undefined';
  thisDev.ShiftRightIntArith = true;
  thisDev.setEnabled({'IntDivRoundTo'});
end
 
% local function
function config = loc_createConfig
  config = rtw.connectivity.ConfigRegistry;
  config.ConfigName = 'Infineon->C16x, XC16x';
  config.ConfigClass = 'pil_slcust.HostDemoConfig1';
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  config.SystemTargetFile = {'custom_target.tlc'};
  config.TemplateMakefile = {'custom_target.tmf'};
  config.TargetHWDeviceType = {'Infineon->C16x, XC16x'};
end
 
function thisTfl = locRegisterTfl
  thisTfl(1) = RTW.TflRegistry;
  thisTfl(1).Name = 'myTFL1';
  thisTfl(1).Description = 'Test';
  thisTfl(1).TableList = {'tfl_table_Sum',...
                          'tfl_table_Product',...
                         }; % Sum includes Add and Subtract
  thisTfl(1).BaseTfl = 'ANSI_C';
  thisTfl(1).TargetHWDeviceType = {'*'};
end

To upgrade the RTW.HWDeviceRegistry data definitions in the file, run:
target.upgrade('sl_customization', 'myPathTo/sl_customization.m')

In the current folder, the function creates this registerUpgradedTargets.m file:
function targetObjects = registerUpgradedTargets(varargin)
% This function was generated using target data export.
 
    % Create target.LanguageImplementation 'MyDevVendor-MyDevType'
    languageimplementation = target.create('LanguageImplementation');
    languageimplementation.AtomicIntegerSize = 8;
    languageimplementation.DataTypes.Char.Size = 8;
    languageimplementation.DataTypes.Double.Size = 64;
    languageimplementation.DataTypes.Float.Size = 32;
    languageimplementation.DataTypes.Half.IsSupported = false;
    languageimplementation.DataTypes.Half.Size = 16;
    languageimplementation.DataTypes.Int.Size = 32;
    languageimplementation.DataTypes.Long.Size = 32;
    languageimplementation.DataTypes.LongLong.IsSupported = false;
    languageimplementation.DataTypes.LongLong.Size = 64;
    languageimplementation.DataTypes.Pointer.Size = 32;
    languageimplementation.DataTypes.PtrDiffT.Size = 32;
    languageimplementation.DataTypes.Short.Size = 16;
    languageimplementation.DataTypes.SizeT.Size = 32;
    languageimplementation.Endianess = target.Endianess.Unspecified;
    languageimplementation.Name = 'MyDevVendor-MyDevType';
    languageimplementation.WordSize = 32;
 
    % Create target.Processor 'MyDevVendor-MyDevType'
    processor = target.create('Processor');
    processor.LanguageImplementations(1) = languageimplementation;
    processor.Manufacturer = 'MyDevVendor';
    processor.Name = 'MyDevType';
 
    % Create target.LanguageImplementation 'MyDevVendor-MyDevType2'
    languageimplementation2 = target.create('LanguageImplementation');
    languageimplementation2.AtomicIntegerSize = 8;
    languageimplementation2.DataTypes.Char.Size = 8;
    languageimplementation2.DataTypes.Double.Size = 64;
    languageimplementation2.DataTypes.Float.Size = 32;
    languageimplementation2.DataTypes.Half.IsSupported = false;
    languageimplementation2.DataTypes.Half.Size = 16;
    languageimplementation2.DataTypes.Int.Size = 32;
    languageimplementation2.DataTypes.Long.Size = 32;
    languageimplementation2.DataTypes.LongLong.IsSupported = false;
    languageimplementation2.DataTypes.LongLong.Size = 64;
    languageimplementation2.DataTypes.Pointer.Size = 32;
    languageimplementation2.DataTypes.PtrDiffT.Size = 32;
    languageimplementation2.DataTypes.Short.Size = 16;
    languageimplementation2.DataTypes.SizeT.Size = 32;
    languageimplementation2.Endianess = target.Endianess.Unspecified;
    languageimplementation2.Name = 'MyDevVendor-MyDevType2';
    languageimplementation2.WordSize = 32;
 
    % Create target.Processor 'MyDevVendor-MyDevType2'
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    processor2 = target.create('Processor');
    processor2.LanguageImplementations(1) = languageimplementation2;
    processor2.Manufacturer = 'MyDevVendor';
    processor2.Name = 'MyDevType2';
 
    targetObjects = [processor, processor2];
 
    % Add the target objects to MATLAB memory
    target.add(targetObjects, varargin{:});
end

To register the hardware device definitions with MATLAB, run:
registerUpgradedTargets()

If you want the registration to persist across MATLAB sessions, run:
registerUpgradedTargets('UserInstall', true)

See Also
target.LanguageImplementation | target.Processor

More About
• “Configure Run-Time Environment Options” on page 9-2
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Model Protection in Simulink Coder

• “Protect Models to Conceal Contents” on page 10-2
• “Create Protected Models with Multiple Targets” on page 10-10
• “Test Protected Models” on page 10-11
• “Package and Share Protected Models” on page 10-13
• “Specify Custom Obfuscators for Protected Models” on page 10-17
• “Define Callbacks for Protected Models” on page 10-18
• “Sign a Protected Model” on page 10-20
• “Best Practices for Creating Protected Models” on page 10-22
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Protect Models to Conceal Contents
When you want to share a model with a third-party without revealing intellectual property, protect
the model. When you create a protected model, you conceal the implementation details of the original
model by compiling it into a referenced model. The protected model includes derived files to support
the optional functionalities that you specify.

When you protect a model, you can allow the user of the protected model to:

• Open a read-only web view of the model, including model contents and block parameters.
• Simulate the model in accelerator (default), rapid accelerator, and normal modes.
• Generate code for a model that includes the protected model.
• Generate HDL code for a model that includes the protected model. To learn about creating

protected models with HDL code generation support, see “Create Protected Models to Conceal
Contents and Generate HDL Code” (HDL Coder).

• Generate code for the protected model through the standalone interface, if you have Embedded
Coder and specify an ERT-based system target file for the model.

You can optionally password-protect each option. If you choose-password protection for one of these
options, the software protects the supporting files by using AES-256 encryption.

When you create a protected model:

• Simulink creates and stores a protected version of the model in a file that has the same name as
the source model, with an .slxp extension.

• The original model file, with the .slx extension, does not change. If you protect the model
through a Model block, that Model block does not change.

• Optionally, Simulink creates a project archive (.mlproj) that contains the protected model, a
harness model for the protected model, and additional supporting files.

To create a protected model from a referenced model, select a Model block that references the
model, then use one of these options:

• On the Simulink Toolstrip Model Block tab, click the Protect button.
• On the Simulink Toolstrip C Code tab, click the Share button arrow, then select Generate

Protected Model From Selected Model Block.

To create a protected model from the current model, use one of these options:

• On the Simulink Toolstrip Simulation tab, click the Save button arrow, then select Protected
Model.

• On the Simulink Toolstrip C Code tab, click the Share button arrow, then select Generate
Protected Model.

To programmatically create a protected model, use the Simulink.ModelReference.protect
function.

If your protected model requires additional supporting files, such as base workspace definitions or a
data dictionary, include these files with the model when you share it. For more information, see
“Package and Share Protected Models” on page 10-13.
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This example shows how to create a protected model from a referenced model for read-only viewing,
simulation, or code generation.

Prepare the Parent Model
Configure the Model blocks in the parent model to refer to the original referenced model. This step
prevents the Model blocks from becoming protected references when you create the protected model.

1 Open the parent model that references the model you want to protect. For this example, open the
model sldemo_mdlref_basic.

2 To run the workflow, create a local copy of the model sldemo_mdlref_counter that you want
to protect. You can then create a local copy of the parent model sldemo_mdlref_basic. You
must save the parent model in the same folder as the referenced model.

3 Open the sldemo_mdlref_basic model that you saved locally. Make sure that the Model blocks
CounterA, CounterB, and CounterC reference the sldemo_mdlref_counter model that you
saved locally.

4 For each Model block, open the Block Parameters dialog box and specify the extension .slx in
the Model name field. When both the model and the protected model exist in the same
folder, .slxp takes precedence over .slx. If you do not specify an extension, then the original
Model block in the model refers to the protected model instead of the original model. Click OK.

Protect the Referenced Model
1 Click any of the three Model blocks. On the Simulink Toolstrip Model Block tab, click Protect.
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2 In the Create Protected Model dialog box, select the Simulate and Use generated code check
boxes. These options allow the protected model user to simulate and generate code for a model
that references the protected model. If you want to password-protect the functionality of the
protected model, enter a password with a minimum of four characters. Each option can have a
unique password.

3 If you have Embedded Coder and specify an ERT-based system target file (for example, ert.tlc)
for the model, the Code interface field is visible.

In this example, sldemo_mdlref_basic does not specify an ERT-based system target file,
therefore the Code interface options are not available in the Create Protected Model dialog box.

From the Code interface drop-down list, select one of these options:

• Model reference — Specifies code access through the model reference code interface,
which allows use of the protected model within a model reference hierarchy. Users of the
protected model can generate code from a parent model that contains the protected model.
Users can run Model block SIL/PIL simulations with the protected model.

• Top model — Specifies code access through the standalone interface. Users of the protected
model can run Model block SIL/PIL simulations with the protected model.
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4 From the Content type list, select Obfuscated source code to conceal the source code
purpose and logic of the protected model. For more information on the model protection options,
see “Content type”.

5 If you have HDL Coder™, you can select the Use generated HDL code check box to generate
HDL code for a model that references the protected model. If you want to password-protect this
functionality of the protected model, you must specify a minimum of eight characters. You cannot
obfuscate the HDL source code for a protected model.

In this example, the referenced model sldemo_mdlref_counter uses double data types. In
the HDL Code Generation > Floating Point tab, set Library to Native Floating Point
and Latency Strategy to ZERO. See also “Create Protected Models to Conceal Contents and
Generate HDL Code” (HDL Coder).

6 In the Destination folder box, specify the folder path for the protected model. The default value
is the current working folder.

7 To automatically collect, create, and package supporting files with the protected model, set
Contents to Protected Model (.slxp) and dependencies in a project.

Note Before sharing the project, check whether the project contains the necessary supporting
files. If supporting files are missing, simulating or generating code for the related harness model
can help identify them. Add the missing dependencies to the project and update the harness
model as needed.

8 Setting Contents to Protected Model (.slxp) and dependencies in a project
selects the Create harness model for protected model check box. The harness model is
included in the project and provides an isolated environment for the Model block that references
the protected model.

9 To further customize your protected model, you can:

• Specify a custom obfuscator for code obfuscation. See “Specify Custom Obfuscators for
Protected Models” on page 10-17.

• Specify multiple code generation targets. See “Create Protected Models with Multiple
Targets” on page 10-10.

• Define callbacks for the protected model. See “Define Callbacks for Protected Models” on
page 10-18.

10 Click Create.

A project archive (.mlproj) that contains the protected model, harness model, and supporting
files appears in the specified destination folder. To test the protected model, extract the contents
of the project archive by double-clicking it in the Current Folder browser and specifying the
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destination folder. Alternatively, right-click on the project archive and click Extract Here. The
project opens, and the extracted files are in a new folder named after the project archive.

11 When you create the protected model from the Simulink Editor, a protected model report is
generated and included as part of the protected model. For this example, to view the protected
model report, double-click the protected model or right-click the protected-model badge icon on
the block in the harness model and select Display Report.

The report contains:

• A Summary, including the following tables:

• Environment, providing the Simulink version and other product versions and the platform
used to create the protected model.

• Supported functionality, reporting On, Off, or On with password protection for
each possible functionality that the protected model supports. If you configure your
protected model for multiple targets, this table includes a list of supported targets.

• An Interface Report, including model interface information such as input and output
specifications, exported function information, interface parameters, and data stores.
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The report does not contain other sections that appear in a code generation report for non-
protected models, such as a code metrics report and traceability report, because these reports
include more information about the model's design.

12 You can test the protected model to compare it to the original model. For more information, see
“Test Protected Models” on page 10-11.

13 To use the protected model in a model hierarchy, reference it through a Model block such as the
one included in the harness model. The Simulation mode for Model blocks that reference a
protected model is set to Accelerator. You cannot change the mode. For more information, see
“Reference Protected Models from Third Parties”.

Protected Model Requirements and Limitations
When you create a protected model, consider these following requirements:

• You must have a Simulink Coder or HDL Coder license to create a protected model.
• The model must be available on the MATLAB path.
• The model cannot have unsaved changes.
• The model cannot use a noninlined S-function directly or indirectly.
• The model uses the configuration that is active during protection. You cannot change the
configuration of a protected model.

• If the model contains variants, the protected model includes only the variant that is active during
protection.

• The model protection process does not preserve callbacks. For more information on creating
callbacks for use with a protected model, see “Define Callbacks for Protected Models” on page 10-
18

• Do not rename the protected model or change its suffix. If you do so, the model is unusable until
you restore its original name and suffix.

• Use a unique name for the model and for models that it references. If a protected model
references a model that shares a name with either a different protected model or a different model
within the hierarchy of another protected model, there are limitations for using the protected
models. If a top model references two protected models that have such a naming conflict, you
cannot protect the top model, generate code for the top model, or simulate the top model in
software-in-the-loop (SIL), processor-in-the-loop (PIL), or rapid accelerator modes.

The model must also meet the requirements listed in “Model Reference Requirements and
Limitations”.

Code Generation Requirements and Limitations
To create a protected model that supports code generation, your model must meet these
requirements:

• The protected model must use normal, accelerator, software-in-the-loop (SIL), or processor-in-the-
loop (PIL) modes and a single target.

• Do not select the Code Generation > Verification > Measure function execution time check
box. If you have this option selected when you protect your model, the software turns off the
parameter and displays a warning.

• Protected referenced models must support code generation without password protection.
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• The protected model must be compatible with the Content type of each protected referenced
model. This table provides compatibility information.

Code Generation Content Type Compatibility
Protected Parent Model Content Type Compatible Protected Referenced Model

Content Types
Binaries • Binaries

• Obfuscated source code
Binaries with 'ObfuscateCode' set to
'false'

• Binaries
• Binaries with 'ObfuscateCode' set to

'false'
• Obfuscated source code
• Readable source code

Obfuscated source code • Obfuscated source code
Readable source code • Obfuscated source code

• Readable source code

When the Content type of the protected parent model and protected referenced models do not
match, code generation applies the Content type that provides the higher level of protection. For
example, a protected parent model set for Binaries generates Binaries for protected
referenced models that are set to Obfuscated source code. A protected parent model set for
Readable source code generates Obfuscated source code for protected referenced
models that are set to Obfuscated source code.

To avoid an error during code generation of a model that includes the protected model:

• The protected model name must be unique from other model names in the same model reference
hierarchy.

• The interfaces must match.
• The parameters must be compatible.

Nested Protected Model Requirements and Limitations
If your protected model is referenced by another model that is protected, your model must:

• Support accelerator mode. You must select Simulate in the Create Protected Model dialog box or
set 'Mode' to 'Accelerator' or 'CodeGeneration' by using the
Simulink.ModelReference.protect function.

• Use the default 'CodeInterface' setting: 'Model reference'.
• Not use password-protection for simulation.
• Not have callbacks.
• Support the operations that the protected parent model supports without password-protection.
• Use a Content type that is compatible with the Content type of the protected parent model if

the protected parent model will support code generation. For a list of compatible Content type
options, see the table in the preceding section.

• Not reference a model that shares a name with either a different protected model or a different
model within the hierarchy of another protected model.
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If the model that you want to protect references a protected model, the protected referenced model
must meet the preceding requirements.

Note A protected model that you create with the Use generated HDL code option selected allows
encryption and support for simulation and HDL code generation from a model that references the
protected model. You cannot obfuscate the HDL source code, have callbacks, or use nested protected
models with this option. To learn more about HDL code generation limitations, see “Protected Model
Restrictions for HDL Code Generation” (HDL Coder).

See Also

More About
• “Package and Share Protected Models” on page 10-13
• “Specify Custom Obfuscators for Protected Models” on page 10-17
• “Create Protected Models with Multiple Targets” on page 10-10
• “Define Callbacks for Protected Models” on page 10-18
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Create Protected Models with Multiple Targets
You can create a protected model that supports multiple code generation targets. This example shows
how to use command-line functions to create a protected model that supports code generation for
GRT and ERT targets.

1 Load a model and save a local copy. This model is configured for a GRT target.

sldemo_mdlref_counter
save_system('sldemo_mdlref_counter','mdlref_counter.slx');

2 Add a required password for modifying a protected model. If you do not add a password, you are
prompted to set a password when you create a modifiable, protected model.

Simulink.ModelReference.ProtectedModel.setPasswordForModify(...
'mdlref_counter','password');

3 Create a modifiable, protected model with support for code generation.

Simulink.ModelReference.protect('mdlref_counter','Mode',...
'CodeGeneration', 'Modifiable',true, 'Report',true);

4 Get a list of targets that the protected model supports.

 st = Simulink.ProtectedModel.getSupportedTargets('mdlref_counter')

st = 

    'grt'    'sim'
5 Configure the unprotected model to support an ERT target.

 set_param('mdlref_counter', 'SystemTargetFile', 'ert.tlc'); 
 save_system('mdlref_counter');

6 Add support to the protected model for the ERT target. You are prompted for the modification
password.

 Simulink.ProtectedModel.addTarget('mdlref_counter');
7 Verify that the list of supported targets now includes the ERT target.

 st = Simulink.ProtectedModel.getSupportedTargets('mdlref_counter')

st = 

    'ert'    'grt'    'sim'

See Also

More About
• “Protect Models to Conceal Contents” on page 10-2
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Test Protected Models
To test a protected model that you created, compare the output of the protected model to the output
of the original model. Because you supply the protected model from the original model, both the
original and the protected model might exist on the MATLAB path. In the parent model, if the Model
block Model name parameter names the model without providing a suffix, the protected model takes
precedence over the unprotected model. To override this default when testing the output, in the
Model block Model name parameter, specify the file name with the extension of the unprotected
model, .slx.

To compare the unprotected and protected versions of a Model block, use the Simulation Data
Inspector. This example uses sldemo_mdlref_basic and the protected model,
sldemo_mdlref_counter.slxp, which is created in “Protect Models to Conceal Contents” on page
10-2.

1 If it is not already open, open sldemo_mdlref_basic.
2 Enable logging for the output signal of the Model block, CounterA. In the Configuration

Parameters dialog box, in the Data Import/Export pane, select the Signal logging parameter.
Click Apply and OK.

3 Right-click the output signal. From the context menu, select Properties. In the Signal
Properties dialog box, select Log signal data. Click Apply and OK. For more information, see
“Export Signal Data Using Signal Logging”.

4 Right-click the CounterA block. From the context menu, select Block Parameters
(ModelReference). In the Block Parameters dialog box, specify the Model name parameter
with the name of the unprotected model and the extension, sldemo_mdlref_counter.slx.
Click Apply and OK. Repeat this step for CounterB block and CounterC block.

5 Simulate the model. When the simulation is complete, click the Data Inspector button to open
the Simulation Data Inspector.

6 In the Simulation Data Inspector, rename the run to indicate that it is for the unprotected model.
7 In the Simulink Editor, right-click the CounterA block. From the context menu, select Block

Parameters (ModelReference). In the Block Parameters dialog box, specify the Model
name parameter with the name of the protected model, sldemo_mdlref_counter.slxp. A
badge icon appears on the Model block. Repeat this step for CounterB block and CounterC
block.

8 Simulate the model, which now refers to the protected model. When the simulation is complete, a
new run appears in the Simulation Data Inspector.

9 In the Simulation Data Inspector, rename the new run to indicate that it is for the protected
model.

10 In the Simulation Data Inspector, click the Compare tab. From the Baseline and Compare To
lists, select the runs from the unprotected and protected model, respectively. To compare the
runs, click Compare Runs. For more information about comparing runs, see “Compare
Simulation Data”.

See Also

More About
• “Protect Models to Conceal Contents” on page 10-2
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• “Package and Share Protected Models” on page 10-13
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Package and Share Protected Models
When you protect a model, you can automatically create and package the following contents in a
project archive (.mlproj) for easy sharing:

• Protected model file (.slxp)
• Harness model file
• MAT-file with base workspace definitions
• Data dictionary pruned to relevant definitions
• Other supporting files

In the Create Protected Model dialog box, set Contents to Protected model (.slxp) and
dependencies in a project.

Note Before sharing the project, check whether the project contains the necessary supporting files.
If supporting files are missing, simulating or generating code for the related harness model can help
identify them. Add the missing dependencies to the project and update the harness model as needed.

Alternatively, you can use one of these options to deliver the protected model package:

• Create a project archive to share a project that contains the protected model file and supporting
files. For more information, see “Create a Project from a Model” and “Share Projects”.

• Provide the protected model file and supporting files as separate files.
• Combine the files into a ZIP or other container file.
• Provide the files in some other standard or proprietary format specified by the receiver.

Whichever approach you use to deliver a protected model, include information on how to retrieve the
original files.

Harness Model
You can create a harness model when you create your protected model. The harness model contains a
Model block that references the protected model. A third-party can use the Model block to reference
your protected model. The harness model is set up for simulation of the protected model.

MAT-File with Base Workspace Definitions
Referenced models can use object definitions or tunable parameters that are defined in the MATLAB
base workspace. These variables are not saved with the model. When you protect a model, you must
obtain the definitions of required base workspace entities and ship them with the model.

For example, if the model uses the following base workspace variables, they must be saved to a MAT-
file:

• Global tunable parameter
• Global data store
• The following objects used by a signal that connects to a root-level model Inport or Outport:
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• Simulink.Signal
• Simulink.Bus
• Simulink.Alias
• Simulink.NumericType that is an alias

To determine the required base workspace definitions and save them to a MAT-file, see “Explore
Protected Model Capabilities”. Before executing the protected model as a part of a third-party model,
the receiver of the protected model must load the MAT-file.

Simulink Data Dictionary
Referenced models can use data definitions from a data dictionary, which are not saved with the
model. When you protect a model that uses a data dictionary, package and ship the data dictionary
with the protected model.

Protected Model File Contents
A protected model file (.slxp) consists of the derived files that support the options that you selected
when you created the protected model. The derived files are unpacked when you or a third-party use
the protected model in simulation. You do not need to package these derived files with the protected
model.

If you created a protected model for simulation only and the referencing model is in Normal mode,
after simulation, the model_msp.mexext file is placed in the build folder. The derived files that are
unpacked depends on the support that you enabled when creating the protected model.
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Protected Model Derived Files

Supported Functionality Derived Files
Created a protected model
for simulation only and the
referencing model is in
Normal mode

The model_msp.mexext file is placed in the build folder.

Created protected model for
simulation only and
referencing model is in
Accelerator or Rapid
Accelerator mode.

These files are unpacked in the slprj/sim/ folder:

• slprj/sim/model/*.h
• slprj/sim/model/modellib.a (or modellib.lib)
• slprj/sim/model/tmwinternal/*
• slprj/sim/_sharedutils/*

For the protected model report, these additional files are unpacked
(but not in the build folder):

• slprj/sim/model/html/*
• slprj/sim/model/buildinfo.mat

Created protected model
with code generation
support.

These files are unpacked in the slprj folder after building your
model (in addition to the preceding files):

• slprj/sim/model/*.h
• slprj/sim/model/modellib.a (or modellib.lib)
• slprj/sim/model/tmwinternal/*
• slprj/sim/_sharedutils/*
• slprj/target/model/*.h
• slprj/target/model/model_rtwlib.a (or

model_rtwlib.lib)
• slprj/target/model/buildinfo.mat
• slprj/target/model/codeinfo.mat
• slprj/target/_sharedutils/*
• slprj/target/model/tmwinternal/*
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Supported Functionality Derived Files
Specified a Top model code
interface (requires
Embedded Coder license)
and enabled code generation
support when creating
protected model.

These files are unpacked in the slprj folder after building your
model (in addition to the preceding files):

• slprj/sim/model/*.h
• slprj/sim/model/modellib.a (or modellib.lib)
• slprj/sim/model/tmwinternal/*
• slprj/sim/_sharedutils/*
• model_target_rtw/*.h
• model_target_rtw/*.objExt
• model_target_rtw/buildinfo.mat
• model_target_rtw/codeinfo.mat
• slprj/target/_sharedutils/*
• slprj/target/model/tmwinternal/*

For the protected model report, after building your model these files
are unpacked (in addition to the preceding files):

• slprj/target/model/html/*
• slprj/target/model/buildinfo.mat
• slprj/target/_sharedutils/html/*

Created protected model
with HDL code generation
support (requires HDL Coder
license).

The files are unpacked in the hdlsrc folder:

• hdlsrc/model/model.vhd(or model.v if you specified Verilog
as the Target language).

• hdlsrc/model/Subsystem.vhd(or Subsystem.v if you
specified Verilog as the Target language of the model that you
protected. The additional HDL files depend on how hierarchically
the referenced model was designed).

• hdlsrc/model/model_pkg.vhd (This file is not generated if you
specified Verilog as the Target language of the model that you
protected).

• hdlsrc/model/model_report.html
• hdlsrc/model/gm_model.slxp (This is a generated protected

model).

Note The slprj/sim/model/* files are deleted after they are used.

See Also

More About
• “Protect Models to Conceal Contents” on page 10-2
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Specify Custom Obfuscators for Protected Models
When creating a protected model, you can specify your own postprocessing function for files that the
protected model creation process generates. Before packaging the protected model files, this function
is called by the Simulink.ModelReference.protect function. You can use this functionality to
run your own custom obfuscator on the generated files by following these steps:

1 Create your postprocessing function. Use this function to call your custom obfuscator. The
function must be on the MATLAB path and accept a
Simulink.ModelReference.ProtectedModel.HookInfo object as an input variable.

2 In your function, get the files and exported symbol information that your custom obfuscator
requires to process the protected model files. To get the files and information, access the
properties of your function input variable. The variable is a
Simulink.ModelReference.ProtectedModel.HookInfo object with the following
properties:

• SourceFiles
• NonSourceFiles
• ExportedSymbols

3 Pass the protected model file information to your custom obfuscator. The following is an example
of a postprocessing function for custom obfuscation:

function myHook(protectedModelInfo)

    % Get source file list information.
    srcFileList = protectedModelInfo.SourceFiles;
    disp('### Obfuscating...');
    for i=1:length(srcFileList)
        disp(['### Obfuscator: Processing ' srcFileList{i} '...']);
        % call to custom obfuscator
        customObfuscator(srcFileList{i});
    end
end

4 Specify your postprocessing function when creating the protected model:

Simulink.ModelReference.protect('myModel, ...
    'Mode', ...
    'CodeGeneration', ...
    'CustomPostProcessingHook', ... 
    @(protectedModelInfo)myHook(protectedModelInfo))

The protected model creator can also enable obfuscation of simulation target code and generated
code through the ‘ObfuscateCode’ option of the Simulink.ModelReference.protect function.
Your custom obfuscator runs only on the generated code and not on the simulation target code or the
generated HDL code. If both obfuscators are in use, the custom obfuscator is the last to run on the
generated code before the files are packaged.

See Also

More About
• “Protect Models to Conceal Contents” on page 10-2
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Define Callbacks for Protected Models
When you create a protected model, you can customize its behavior by defining callbacks. Callbacks
specify code that executes when you view, simulate, or generate code for the protected model. You
cannot have protected model callbacks with HDL code generation support enabled for a protected
model. To learn more about HDL code generation limitations, see “Protected Model Restrictions for
HDL Code Generation” (HDL Coder).

A protected model user cannot view or modify a callback. If a model references a protected model
with callbacks, you cannot protect the model.

To create a protected model with callbacks:

1 Define Simulink.ProtectedModel.Callback objects for each callback.
2 To create your protected model, call the Simulink.ModelReference.protect function. Use

the 'Callbacks' option to specify a cell array of callbacks to include in the protected model.

Creating Callbacks
To create and define a protected model callback, create a Simulink.ProtectedModel.Callback
object. Callback objects specify:

• The code to execute for the callback. The code can be a character vector of MATLAB commands or
a script on the MATLAB path.

• The event that triggers the callback. The event can be 'PreAccess' or 'Build'.
• The protected model functionality that the event applies to. The functionality can be 'CODEGEN',

'SIM', 'VIEW', or 'AUTO'. If you select 'AUTO', and the event is 'PreAccess', the callback
applies to each functionality. If you select 'AUTO', and the event is 'Build', the callback applies
only to 'CODEGEN' functionality. If you do not select a functionality, the default behavior is
'AUTO'.

• The option to override the protected model build process. This option applies only to 'CODEGEN'
functionality.

You can create only one callback per event and per functionality.

Defining Callback Code
You can define the code for a callback by using either a character vector of MATLAB commands or a
script on the MATLAB path. When you write callback code, follow these guidelines:

• Callbacks must use MATLAB code (.m or .p).
• The code can include protected model functions or a MATLAB command that does not require

loading the model.
• Callback code must not call out to external utilities unless those utilities are available in the

environment where the protected model is used.
• Callback code cannot reference the source protected model unless you are using protected model

functions.

You can use the Simulink.ProtectedModel.getCallbackInfo function in callback code to get
information on the protected model. The function returns a
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Simulink.ProtectedModel.CallbackInfo object that provides the protected model name and
the names of submodels. If the callback is specified for 'CODEGEN' functionality and 'Build' event,
the object provides the target identifier and model code interface type ('Top model' or 'Model
reference').

Create a Protected Model with Callbacks
This example creates a protected model with a callback for code generation.

1 On the MATLAB path, create a callback script, pm_callback.m, containing:

s1 = 'Code interface is: ';
cbinfobj = Simulink.ProtectedModel.getCallbackInfo(...
'sldemo_mdlref_counter','Build','CODEGEN');
disp([s1 cbinfobj.CodeInterface]);

2 Create a callback that uses the script.

pmCallback = Simulink.ProtectedModel.Callback('Build',...
'CODEGEN', 'pm_callback.m');

3 Create the protected model and specify the code generation callback.

Simulink.ModelReference.protect('sldemo_mdlref_counter',...
'Mode', 'CodeGeneration','Callbacks',{pmCallback})

4 Build the protected model. Before the build, the callback displays the code interface.

slbuild('sldemo_mdlref_basic')

See Also
Simulink.ModelReference.protect | Simulink.ProtectedModel.Callback |
Simulink.ProtectedModel.getCallbackInfo

More About
• “Protect Models to Conceal Contents” on page 10-2
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Sign a Protected Model
A digital signature is a method of verifying information about the origin of a digital message or file.
You can digitally sign a protected model to allow the user of the model to verify:

• That the model was created by you, the publisher that signed the model.
• That the model was not changed after you signed it.

By using digital signature validation, the recipient can detect issues, such as an unfamiliar publisher
or a tampered model, before opening or executing a protected model.

These parties interact in the digital signing workflow:

• The creator of the protected model
• The recipient who uses the protected model
• An external certificate authority (CA) that the creator and the recipient trust

To exchange a protected model with certificate validation, they use this workflow:

1 The certificate authority provides a digital certificate, which proves that a public key belongs to
the creator of the model. The certificate authority also provides the corresponding public
certificate to the model recipient.

2 The creator signs the protected model by using the private key that corresponds to the public key
in the certificate. The creator sends the signed protected model to the recipient.

3 The recipient verifies the signature on the protected model. Verification compares the signature
on the model to the certificate attached to the model and to the certificate of the CA. Verification
fails if:

• The protected model was changed after it was signed.
• The protected model was not signed.
• The protected model was signed with an expired certificate.
• The protected model was self-signed with a certificate issued by the author.
• The protected model was signed with a missing or invalid certificate.
• The certificate of the CA is missing in your system or is invalid.

As the model creator, you generate a public-private key pair and obtain a certificate for the public key
from the CA. Then, you create a PKCS #12 file (.pfx file or .p12 file) that includes the private key
and the certificate. Because the PKCS #12 file contains the private key, it is typically password-
protected. Follow this workflow to sign your protected model before you send it to the recipient.

Sign Your Protected Model
To sign a protected model, use a certificate that is issued to you by a certificate authority (CA) that
you and the user of the model both trust. If you sign a protected model using a self-signed certificate
or a certificate issued by an internal CA, the recipient’s system must trust the certificate for the
signature validation to succeed. Using a self-signed certificate to sign protected models is not
recommended.

1 Locate the PKCS #12 file that you or your organization created from the private key and the
certificate. The file must have a .pfx or .p12 extension.
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2 Protect the model that you want to sign. The protected version of the model has the
extension .slxp.

3 Provide the password for the PKCS #12 file.
Simulink.ModelReference.ProtectedModel.setPasswordForCertificate('certificate_file.pfx',...
'password');

4 Sign the model by using the PKCS #12 file.
Simulink.ProtectedModel.sign('protected_model.slxp','certificate_file.pfx');

Your protected model is now signed with the PKCS #12 file. Do not change the protected model after
you sign it. If you or another party changes the signed protected model, verification of the signature
fails and the protected model cannot be used.

The recipient can verify the protected model by using the function
Simulink.ProtectedModel.verifySignature or by selecting the Simulink preference Verify
digital signature of protected model before opening. For more information, see “Reference Protected
Models from Third Parties”.

See Also
Simulink.ProtectedModel.sign

More About
• “Protect Models to Conceal Contents” on page 10-2
• “Reference Protected Models from Third Parties”
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Best Practices for Creating Protected Models
When you want to conceal the implementation details of a model that you share with a third party,
create a protected model. Instead of including your original model files, the protected model includes
derived files to support the functionalities that you specify. To create a protected model that supports
functionalities that your user requires and that includes minimal information about your model,
follow these best practices. The settings that you choose for the model before and during protection
specify what the user of the protected model can do with it. Consider the trade-offs of different design
options. To support additional functionalities, the protected model must include more content and
therefore, more elements of your design might be visible. Because the protected model uses derived
artifacts from a compiled model reference, you cannot change the model after you protect it.

Coordinate Settings with the User of Your Protected Model
When you develop a model that you will protect, coordinate with the user of the protected model to
choose settings that allow their system to reference your protected model. After you protect your
model, you cannot modify options such as configuration parameter settings to make your protected
model compatible with a parent model. Before you protect your model, configure it to use compatible
options.

Choose a Unique Model Name

You cannot change the name of your protected model after you protect it. To avoid name conflicts,
choose a model name that is unique from other models in the system. Choose a model name that does
not conflict with other models within your user's model hierarchy. Use the name to save your source
(unprotected) model before you protect it.

Configure Model Parameters

Before you protect your model, choose configuration parameter settings by coordinating with the
user of your protected model. When the parent model references your protected model, the
configuration parameters of the models must be compatible. For example, if you set the parameter
Solver to Variable-step for your protected model, the model that references your protected model
must have Solver set to Variable-step. If your model contains multiple configuration sets, the
protected model uses the configuration set that is active when you protect the model. To minimize
parameter incompatibilities, send your model configuration set to the user of your protected model so
that they can use the configuration for their parent model. For more information, see “Share a
Configuration with Multiple Models”.

Minimize the Model External Interface
Except for input and output ports, minimize the number of design elements that provide an interface
into your model. To allow interfacing with external components, the protected model does not protect
those design elements. For the following items, consider these alternative options that allow
protection.

• Tunable Parameters — Minimize the number of tunable parameters in the code that use a storage
class other than Auto or Localizable. Parameters that use a global storage class in your
model's generated code are visible in the code for the protected model. If the user of your
protected model requires access to tunable parameters, agree on a list of the parameters that the
protected model provides. For more information, see “C Code Generation Configuration for Model
Interface Elements”.
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• Data Objects — Data objects, including parameter and signal data objects, data type objects, and
bus objects, that you store externally are not protected. Include only data objects that the user of
the protected model requires access to. Use the data objects to monitor signals and calibrate
parameters while you develop your model. After calibration, specify values for the parameters,
and then inline them. For more information, see “Data Objects”.

• Data Stores — Do not use global data stores on signal objects. Global data stores can make data
visible across referenced models. Instead, use inports and outports to communicate data across
model references. You can use Data Store Memory blocks as data stores that are local to your
model. For more information, see “Local and Global Data Stores”.

• Model Arguments — Minimize the number of arguments that your model uses. When your
protected model uses arguments, the user of your protected model must specify values for the
arguments in the parent model. These data items are visible to the user of your protected model.
For each model argument that your model uses, communicate the argument specifications to the
user of your protected model.

• Simulink Functions — Consider the scope of Simulink functions that your model uses. When a
Simulink function has a global scope or is scoped at the root level of your model, it provides a
visible interface with your protected model. If you do not want a Simulink function to interface
into your protected model, consider specifying a scope within a subsystem of your model. For
more information, see “Scoped Simulink Function Blocks in Subsystems”.

• Logging Blocks — Do not use block-based logging in your protected model. To File blocks and To
Workspace blocks that use the Timeseries format function in protected models, and therefore
make the logged data visible to the protected model user. Signal logging, and other options that
use the signal selector, do not work for signals inside a protected model.

Design Options in Your Protected Model

If you want to use one of the preceding design elements while you develop your model, but the
element is not required by the user of the model, you can use variants to exclude the design element
from your protected model. An example is using a To File block during testing to log data that the
user of the protected model does not require access to. To exclude the block by using variants:

1 Insert a variant block, such as a Manual Variant Sink block, on the signal that leads to the To File
block.

2 Connect the first output of the variant block to the To File block.
3 Connect the second output of the variant block to a Terminator block to terminate the signal.
4 To log the signal while testing the model, activate the first variant output.
5 To protect the model without using the logging block, activate the second variant output. The

protected model uses only the active variant, so the signal is terminated without being logged.
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Contents to Include in Your Protected Model
Model Protection Options

When you specify functionalities for your protected model, the protected model includes artifacts to
support those functionalities. Limiting the included artifacts enables you to control what contents are
visible to the user of your model or to an external attacker that wants to view or change your model
without permission. Consider the trade-offs of different design options. To support additional
functionalities, the protected model must include more content and therefore, more elements of your
design might be visible. Coordinate with the user of your model to agree on what functionalities they
require. Specify support for only those functionalities.

• Obfuscated source code — Use this option when the user of your protected model must compile
the generated source code. The protected model includes an obfuscated version of the generated
source code. It behaves the same as your source code but is more difficult to understand for the
model user and potential attackers.

• Compiled code — Use this option when the user of your protected model can use the compiled
library from your protected model. The protected model includes the binary files and header files
compiled from your generated source code. It does not include the source code. This option
prevents the user of your model and potential attackers from accessing the model's generated
source code.

• Password protection — Use this option to support some functionality for your protected model's
user and protect the supporting files from external attackers. For each option that you specify a
password, the derived files that support that option are protected by using AES-256 encryption.
Before executing each functionality, the protected model prompts the user for a password.
Coordinate with the user of your protected model to choose the password for each option. If your
protected model is referenced by a parent model that will also be protected, do not password-
protect functionalities that the parent protected model will support.

• Digital signature — Sign your protected model by using a certificate to protect the recipient from
using the model if it has been changed by an external attacker. When you sign your model, the
user of the model can verify that the protected model is published by you and did not change after
you signed it. After you sign the model, if it is changed, a user cannot use it. Make sure that the
user's computer storage of trusted certificates has the certificate from the certificate authority
that certified your certificate.
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Interface Report

When you create a protected model, the generated protected model report includes an interface
report. The interface report includes information about input and output specifications, exported
functions, interface parameters, and data stores. Use the interface report as a reference to
communicate with the user of your protected model.

Create a Harness Model

When you create a protected model, you have the option to create a harness model that references
your protected model. Use the harness model to define information that the user requires to interface
your protected model with their system. The harness contains the same configuration set that your
protected model uses. In the harness model, you can include data definitions that your protected
model uses.

See Also

More About
• “Protect Models to Conceal Contents” on page 10-2
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Generate Code That Responds to Initialize, Reset, and
Terminate Events

To generate code from a modeling component that responds to initialize, reset, and terminate events
during execution, use the blocks Initialize Function and Terminate Function. For information on how
to use these blocks, see “Using Initialize, Reset, and Terminate Functions”. You can use the blocks
anywhere in a model hierarchy.

Examples of when to generate code that responds to initialize, reset, or terminate events include:

• Starting and stopping a component.
• Calculating initial conditions.
• Saving and restoring state from nonvolatile memory.
• Generating reset entry-point functions that respond to external events.

Each nonvirtual subsystem and referenced model can have its own set of initialize, reset, and
terminate functions.

The code generator produces initialization and termination code differently than reset code. For
initialization and termination code, the code generator includes your component initialization and
termination code in the default entry-point functions, model_initialize and model_terminate.
The code generator produces reset code only if you model reset behavior.

Generate Code for Initialize and Terminate Events
When you generate code for a component that includes Initialize Function and Terminate Function
blocks, the code generator:

• Includes initialize event code with default initialize code in entry-point function
model_initialize.

• Includes terminate event code with default terminate code in entry-point function
model_terminate.

Consider the model rtwdemo_irt_base.

For this model, the code generator produces initialize and terminate entry-point functions that other
code can interface with.

void rtwdemo_irt_base_initialize(void)
void rtwdemo_irt_base_terminate(void)

This code appears in the generated file rtwdemo_irt_base.c. The initialize function,
rtwdemo_irt_base_initialize:
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• Initializes an error status.
• Allocates memory for block I/O and state parameters.
• Sets the output value
• Sets the initial condition for the discrete integrator.

The terminate function, ,rtwdemo_irt_base_terminate, requires no code.

This code assumes that support for nonfinite numbers and MAT-file logging is disabled.

void rtwdemo_irt_base_initialize(void)
{
  rtmSetErrorStatus(rtwdemo_irt_base_M, (NULL));

  (void) memset((void *)&rtwdemo_irt_base_DW, 0,
                 sizeof(DW_rtwdemo_irt_base_T));   
      
  rtwdemo_irt_base_Y.Out1 = 0.0;

  rtwdemo_irt_base_DW.DiscreteIntegrator_DSTATE = 0.0;
}
    
void rtwdemo_irt_base_terminate(void)
{
  /* (no terminate code required) */
}

Add Initialize Function and Terminate Function blocks to the model (see rtwdemo_irt_initterm).
The Initialize Function block uses the State Writer block to set the initial condition of a Discrete
Integrator block. The Terminate Function block includes a State Reader block, which reads the state
of the Discrete Integrator block.

Parameter Event type for the Event Listener block for the initialize and terminate functions is set to
Initialize and Terminate, respectively. The initialize function uses the State Writer block to
initialize the input value for the Discrete Integrator block to 10. The terminate function uses the State
Reader block to read the state of the Discrete Integrator block.
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The code generator includes the event code that it produces for the Initialize Function and Terminate
Function blocks with standard initialize and terminate code in entry-point functions
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rtwdemo_irt_initterm_initialize and rtwdemo_irt_initterm_terminate. This code
assumes that support for nonfinite numbers and MAT-file logging is disabled.

void rtwdemo_irt_initterm_initialize(void)
{
  rtmSetErrorStatus(rtwdemo_irt_initterm_M, (NULL));
        
  (void) memset((void *)&rtwdemo_irt__initterm_DW, 0,
              sizeof(DW_rtwdemo_irt__initterm_T));
    
  rtwdemo_irt_initterm_Y.Out1 = 0.0;

  rtwdemo_irt_initterm_DW.DiscreteIntegrator_DSTATE = 10.0;
}

void rtwdemo_irt__initterm_terminate(void)
{
  /* (no terminate code required) */
} 

Generate Code for Reset Events
Generate code that responds to a reset event by including an Initialize Function or Terminate
Function block in a modeling component. Configure the block for a reset by setting the Event type
parameter of its Event Listener block to Reset. Also set the Event name parameter. The default
name is reset.

The code generator produces a reset entry-point function only if you model reset behavior. If a
component contains multiple reset specifications, the code that the code generator produces depends
on whether reset functions share an event name. For a given component hierarchy:

• For reset functions with unique event names, the code generator produces a separate entry-point
function for each named event. The name of each function is the name of the corresponding event.

• For reset functions that share an event name, the code generator aggregates the reset code into
one entry-point function. The code for the reset functions appears in order, starting with the
lowest level (innermost) of the component hierarchy and ending with the root (outermost). The
name of the function is model_reset. For more information, see “Event Names and Code
Aggregation”.

Consider the model rtwdemo_irt_reset, which includes a Reset Function block derived from an
Initialize Function block.
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The Event type and Event name parameters of the Event Listener block are set to Reset and
reset, respectively. The function uses the State Writer block to reset the input value for the Discrete
Integrator block to 5.

The code generator produces reset function rtwdemo_irt_reset_reset.

void rtwdemo_irt_reset_reset(void)

{
  rtwdemo_irt_reset_DW.DiscreteIntegrator_DSTATE = 5.0;
}

11 Component Initialization, Reset, and Termination in Simulink Coder

11-6



Event Names and Code Aggregation
Use the Initialize Function and Terminate Function blocks to define multiple initialize, reset, and
terminate functions for a component hierarchy. Define only one initialize function and one terminate
function per hierarchy level. You can define multiple reset functions for a hierarchy level. The event
names that you configure for the functions at a given level must be unique.

When producing code, the code generator aggregates code for functions that have a given event
name across the entire component hierarchy into one entry-point function. The code for reset
functions appears in order, starting with the lowest level (innermost) of the component hierarchy and
ending with the root (outermost). The code generator uses the event name to name the function.

For example, the model rtwdemo_irt_shared includes a subsystem that replicates the initialize,
reset, and terminate functions that are in the parent model.

Although the model includes multiple copies of the initialize, reset, and terminate functions, the code
generator produces one entry-point function for reset (rtwdemo_irt_shared_reset), one for
initialize (rtwdemo_irt_shared_initialize), and one for terminate
(rtwdemo_irt_shared_terminate). Within each entry-point function, after listing code for blocks
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configured with an initial condition (model_P.block_IC), the code generator orders code for
components, starting with the lowest level of the hierarchy and ending with the root.

.

.

.
void rtwdemo_irt_shared_reset(void)
{
  rtwdemo_irt_shared_DW.SubIntegrator2_DSTATE = 5.0;

  rtwdemo_irt_shared_DW.Integrator2_DSTATE = 5.0;
} 
.
.
.
void rtwdemo_irt_shared_initialize(void)
{
  rtmSetErrorStatus(rtwdemo_irt_shared_M, (NULL));

  (void) memset(((void *)&rtwdemo_irt_shared_DW), 0,
                sizeof(DW_rtwdemo_irt_shared_T));

  rtwdemo_irt_shared_Y.Out1 = 0.0;

  rtwdemo_irt_shared_DW.Integrator1_DSTATE = 0.0;

  rtwdemo_irt_shared_DW.SubIntegrator2_DSTATE = 2.0;

  rtwdemo_irt_shared_DW.Integrator2_DSTATE = 10.0;
.
.
.
void rtwdemo_irt_shared_terminate(void)
{
   /* (no terminate code required) */
   }

If you rename the event configured for the subsystem reset function to reset_02, the code generator
produces two reset entry-point functions, rtwdemo_irt_shared_reset and
rtwdemo_irt_shared_reset_02.

void rtwdemo_irt_shared_reset(void)
{
      rtwdemo_irt_shared_DW.SubIntegrator2_DSTATE = 5.0;
}
 
void rtwdemo_irt_shared_reset_02(void)
{
   rtwdemo_irt_shared_DW.Integrator2_DSTATE = 5.0;
}

Limitation
You cannot generate code from a harness model—a root model that contains a Model block, which
exposes initialize, reset, or terminate function ports.
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See Also

Related Examples
• “Using Initialize, Reset, and Terminate Functions”
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Initialization of Signal, State, and Parameter Data in the Generated Code” on page 34-185
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• “Code Generation of Stateflow Blocks” on page 12-2
• “Generate Code from Atomic Subcharts” on page 12-5
• “Inline State Functions in Generated Code” on page 12-7
• “Air-Fuel Ratio Control System with Stateflow Charts” on page 12-10
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Code Generation of Stateflow Blocks
The code generator produces code for Stateflow blocks for rapid prototyping. If you have an
Embedded Coder license, you can generate production code for Stateflow blocks.

Comparison of Code Generation Methods
The following sections compare two ways of generating code.

Code Generation Without Atomic Subcharts

You generate code for the entire model in one file and look through that entire file to find code for a
specific part of the chart.
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Code Generation With Atomic Subcharts

You specify code generation parameters so that code for an atomic subchart appears in a separate
file. This method of code generation enables unit testing for a specific part of a chart. You can avoid
searching through unrelated code and focus only on the part that interests you.

Note Unreachable Stateflow states are optimized out and are not included in the generated code.
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See Also

Related Examples
• “Generate Code from Atomic Subcharts” on page 12-5
• “Generate C or C++ Code from Stateflow Blocks” (Stateflow)
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Generate Code from Atomic Subcharts
To unit test a Stateflow chart in a Simulink model, first break the chart into smaller, independent
components by using atomic subcharts. When you generate code for your chart, a separate file stores
the code for the atomic subchart. Generating reusable code from atomic subcharts is useful for
testing individual parts of your Stateflow chart. For more information, see “Create Reusable
Subcomponents by Using Atomic Subcharts” (Stateflow).

Generate Reusable Code for Unlinked Atomic Subcharts
To specify code generation parameters for an unlinked atomic subchart:

1 In your chart, right-click the atomic subchart and select Properties.
2 In the dialog box, specify these parameters:

a Set Code generation function packaging to Reusable function.
b Set Code generation file name options to User specified.
c For Code generation file name, enter the name of the file with no extension.

3 Open the Configuration Parameters dialog box by pressing Ctrl+E.
4 In the Code Generation tab, set the System target file parameter to ert.tlc.
5 (OPTIONAL) Customize the generated function names for atomic subcharts. In the Configuration

Parameters dialog box, in the Code Generation > Identifiers tab, set the Subsystem methods
parameter. Specify the format of the function names by using a combination of these tokens:

• $R — root model name
• $F — type of interface function for the atomic subchart
• $N — block name
• $H — subsystem index
• $M — name-mangling text

For more information, see “Generate Separate Code for an Atomic Subchart” (Stateflow).

Generate Reusable Code for Linked Atomic Subcharts
To specify code generation parameters for linked atomic subcharts from the same library:

1 Open the library model that contains your atomic subchart.
2 Unlock the library.
3 Right-click the library chart and select Block Parameters.
4 In the dialog box, specify these parameters:

a On the Main tab, select Treat as atomic unit.
b On the Code Generation tab, set Function packaging to Reusable function.
c Set File name options to User specified.
d For File name, enter the name of the file with no extension.

5 In the Code Generation tab, set the System target file parameter to ert.tlc.
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6 (OPTIONAL) Customize the generated function names for atomic subcharts. In the Configuration
Parameters dialog box, in the Code Generation > Identifiers tab, set the Subsystem methods
parameter. Specify the format of the function names by using a combination of these tokens:

• $R — root model name
• $F — type of interface function for the atomic subchart
• $N — block name
• $H — subsystem index
• $M — name-mangling text

When you generate code for your model, a separate file stores the code for linked atomic subcharts
from the same library.

See Also

More About
• “Create Reusable Subcomponents by Using Atomic Subcharts” (Stateflow)
• “Generate C or C++ Code from Stateflow Blocks” (Stateflow)
• “Generate Separate Code for an Atomic Subchart” (Stateflow)
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Inline State Functions in Generated Code
In this section...
“Inlined Generated Code for State Functions” on page 12-7
“How to Set the State Function Inline Option” on page 12-8
“Best Practices for Controlling State Function Inlining” on page 12-8

Inlined Generated Code for State Functions
By default, the code generator uses an internal heuristic to determine whether to inline generated
code for state functions. The heuristic takes into consideration an inlining threshold. As code grows
and shrinks in size, generated code for state functions can be unpredictable.

If your model includes Stateflow objects and you have rigorous requirements for traceability between
generated code and the corresponding state functions, you can override the default behavior. Use the
state property Function Inline Option to explicitly force or prevent inlining of state functions.

What Happens When You Force Inlining

If you force inlining for a state, the code generator inlines code for state actions into the parent
function. The parent function contains code for executing the state actions, outer transitions, and
flow charts. It does not include code for empty state actions.

What Happens When You Prevent Inlining

If you prevent inlining for a state, the code generator produces these static functions for state foo.

Function Description
enter_atomic_foo Marks foo active and performs entry actions.
enter_internal_foo Calls default paths.
inner_default_foo Executes flow charts that originate when an inner

transition and default transition reach the same
junction inside a state.

The code generator produces this function only
when the flow chart is complex enough to exceed
the inlining threshold.

In generated code, Stateflow software calls this
function from both the enter_internal_foo
and foo functions.

foo Checks for valid outer transitions and if none,
performs during actions.

exit_atomic_foo Performs exit actions and marks foo inactive.
exit_internal_foo Performs exit actions of the child substates and

then exits foo.

Suppose the following chart is in model M.
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If you prevent inlining for state A, the code generator produces this code.

static void M_inner_default_A(void);
static void M_exit_atomic_A(void);
static void M_A(void);
static void M_enter_atomic_A(void);
static void M_enter_internal_A(void);

How to Set the State Function Inline Option
To set the function inlining property for a state:

1 Right-click inside the state and, from the context menu, select Properties.

The State properties dialog box opens.
2 For property Function Inline Option, select one of these values.

Value Behavior
Inline Forces inlining of state functions into the parent function, as long as the

function is not part of a recursion. See “What Happens When You Force
Inlining” on page 12-7.

Function Prevents inlining of state functions. Generates up to six static functions for
the state. See “What Happens When You Prevent Inlining” on page 12-7.

Auto Uses internal heuristics to determine whether or not to inline the state
functions.

3 Click Apply.

Best Practices for Controlling State Function Inlining
To Set Function Inline Option Property To
Generate a separate function for each action of a
state and a separate function for each action of
its substates

Function for the state and each substate
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To Set Function Inline Option Property To
Generate a separate function for each action of a
state, but include code for the associated action
of its substates

Function for the state and Inline for each
substate
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Air-Fuel Ratio Control System with Stateflow Charts
Generate code for an air-fuel ratio control system designed with Simulink® and Stateflow®.

Figures 1, 2, and 3 show relevant portions of the sldemo_fuelsys model, a closed-loop system
containing a plant and controller. The plant validates the controller in simulation early in the design
cycle. In this example, you generate code for the relevant controller subsystem, "fuel_rate_control".
Figure 1 shows the top-level simulation model.

Use the command rtwdemo_fuelsys to open model sldemo_fuelsys. Then, compile the model to
see the signal data types.

rtwdemo_fuelsys
sldemo_fuelsys([],[],[],'compile');
sldemo_fuelsys([],[],[],'term');

Figure 1: Top-level model of the plant and controller

The air-fuel ratio control system is comprised of Simulink® and Stateflow®. The control system is the
portion of the model for which you generate code.

open_system('sldemo_fuelsys/fuel_rate_control');
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Figure 2: The air-fuel ratio controller subsystem

The control logic is a Stateflow® chart that specifies the different modes of operation.

open_system('sldemo_fuelsys/fuel_rate_control/control_logic');

Figure 3: Air-fuel rate controller logic

Close these windows.
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close_system('sldemo_fuelsys/fuel_rate_control/airflow_calc');
close_system('sldemo_fuelsys/fuel_rate_control/fuel_calc');
close_system('sldemo_fuelsys/fuel_rate_control/control_logic');
hDemo.rt=sfroot;hDemo.m=hDemo.rt.find('-isa','Simulink.BlockDiagram');
hDemo.c=hDemo.m.find('-isa','Stateflow.Chart','-and','Name','control_logic');
hDemo.c.visible=false;
close_system('sldemo_fuelsys/fuel_rate_control');

Configure and Build the Model with Embedded Coder®

To configure and build production ANSI® C/C++ code for the model, set model configuration
parameter System target file to ert.tlc (Embedded Real-Time (ERT)). You can set the System
target file parameter programmatically.

rtwconfiguredemo('sldemo_fuelsys','ERT');

Generate and inspect the code. You can navigate to the relevant code segments interactively by using
Previous and Next buttons. From the chart context menu (right-click the Stateflow® block), select
C/C++ Code > Navigate to C/C++ Code. Programmatically, use the rtwtrace utility.

slbuild('sldemo_fuelsys/fuel_rate_control');
rtwtrace('sldemo_fuelsys/fuel_rate_control/control_logic')

### Starting build procedure for: fuel_rate_control
### Successful completion of build procedure for: fuel_rate_control

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                                    
==================================================================================================
fuel_rate_control  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 43.489s

View the air-fuel ratio control logic in the generated code.

rtwdemodbtype('fuel_rate_control_ert_rtw/fuel_rate_control.c',...
    '/* Function for Chart:','case IN_Warmup:',1,0);

/* Function for Chart: '<S1>/control_logic' */
static void Fueling_Mode(const int32_T *sfEvent)
{
  switch (rtDWork.bitsForTID0.is_Fueling_Mode) {
   case IN_Fuel_Disabled:
    rtDWork.fuel_mode = DISABLED;
    switch (rtDWork.bitsForTID0.is_Fuel_Disabled) {
     case IN_Overspeed:
      /* Inport: '<Root>/sensors' */
      if ((rtDWork.bitsForTID0.is_Speed == 2) && (rtU.sensors.speed < 603.0F)) {
        if (rtDWork.bitsForTID0.is_Fail != 1) {
          rtDWork.bitsForTID0.is_Fuel_Disabled = IN_NO_ACTIVE_CHILD;
          rtDWork.bitsForTID0.is_Fueling_Mode = IN_Running;

          /* The fuel is actively controlled while in this state. */
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          switch (rtDWork.bitsForTID0.was_Running) {
           case IN_Low_Emissions:
            rtDWork.bitsForTID0.is_Running = IN_Low_Emissions;
            rtDWork.bitsForTID0.was_Running = IN_Low_Emissions;
            rtDWork.fuel_mode = LOW;
            switch (rtDWork.bitsForTID0.was_Low_Emissions) {
             case IN_Normal:
              rtDWork.bitsForTID0.is_Low_Emissions = IN_Normal;
              rtDWork.bitsForTID0.was_Low_Emissions = IN_Normal;

              /* All sensors are in correct operating modes, so effective closed-loop mixture control can be used. */
              break;

Close the model and code generation report.

clear hDemo;
rtwdemoclean;
close_system('sldemo_fuelsys',0);

Related Examples

For related fixed-point examples that use sldemo_fuelsys, see

• Fixed-point design - “Fixed-Point Fuel Rate Control System” (Fixed-Point Designer)
• Fixed-point production C/C++ code generation - “Air-Fuel Ratio Control System with Fixed-

Point Data” on page 34-201
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S-Functions and Code Generation
You use S-functions to extend Simulink support for simulation and code generation. For example, you
can use them to:

• Represent custom algorithms
• Interface existing external code with Simulink model and the generated code
• Represent device drivers for interfacing with hardware
• Generate highly optimized code for embedded systems
• Verify code generated for a subsystem as part of a Simulink simulation

The application program interface (API) for writing S-functions allows you to implement generic
algorithms in the Simulink environment with a great deal of flexibility. If you intend to use S-functions
in a model for code generation, the level of flexibility can vary. For example, it is not possible to
access the MATLAB workspace from an S-function that you use with the code generator. This topic
explains conditions to be aware of for using S-functions. However, using the techniques presented in
this topic, you can create S-functions for most applications that work with the generated code.

Although S-functions provide a generic and flexible solution for implementing complex algorithms in
a model, the underlying API incurs overhead in terms of memory and computation resources. Most
often the additional resources are acceptable for real-time rapid prototyping systems. Often, though,
additional resources are unavailable in real-time embedded applications. You can minimize memory
and computational requirements by using the Target Language Compiler technology provided with
the code generator to inline your S-functions. If you are producing an S-function for existing external
code, consider using the Legacy Code Tool to generate your S-function and relevant TLC file.

This topic assumes that you understand the following concepts:

• Level-2 S-functions
• Target Language Compiler (TLC) scripting
• How the code generator produces and builds C/C++ code

Notes This information is for code generator users. Even if you do not currently use the code
generator, follow these practices when writing S-functions, especially if you are creating general-
purpose S-functions.

Types of S-Functions
Examples for which you might choose to implement an S-function for simulation and code generation
include:

1 “I'm not concerned with efficiency. I want to write one version of my algorithm and have it work
in the Simulink and code generator products automatically.”

2 “I want to implement a highly optimized algorithm in the Simulink and code generator products
that looks like a built-in block and generates efficient code.”

3 “I have a lot of hand-written code that I need to interface. I want to call my function from the
Simulink and code generator products efficiently.”

Respectively, the preceding situations map to the following MathWorks terminology:
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1 Noninlined S-function
2 Inlined S-function
3 Auto-generated S-function for external code

Noninlined S-Functions

A noninlined S-function is a C or C++ MEX S-function that is treated identically by the Simulink
engine and generated code. In general, you implement your algorithm once according to the S-
function API. The Simulink engine and generated code call the S-function routines (for example,
mdlOutputs) during model execution.

Additional memory and computation resources are required for each instance of a noninlined S-
Function block. However, this routine of incorporating algorithms into models and code generation
applications is typical during the prototyping phase of a project where efficiency is not important. The
advantage gained by forgoing efficiency is the ability to change model parameters and structures
rapidly.

Writing a noninlined S-function does not involve TLC coding. Noninlined S-functions are the default
case for the build process in the sense that once you build a MEX S-function in your model, there is
no additional preparation before pressing Ctrl+B to build your model.

Some restrictions exist concerning the names and locations of noninlined S-function files when
generating makefiles. See “Write Noninlined S-Function” on page 13-95.

Inlined S-Functions

For S-functions to work in the Simulink environment, some overhead code is generated. When the
code generator produces code from models that contain S-functions (without sfunction.tlc files),
it embeds some of this overhead code in the generated code. If you want to optimize your real-time
code and eliminate some of the overhead code, you must inline (or embed) your S-functions. This
involves writing a TLC (sfunction.tlc) file that eliminates overhead code from the generated code.
The Target Language Compiler processes sfunction.tlc files to define how to inline your S-
function algorithm in the generated code.

Note Do not confuse the term inline with the C++ inline keyword. Inline means to specify text in
place of the call to the general S-function API routines (for example, mdlOutputs). For example,
when a TLC file is used to inline an S-function, the generated code contains the C/ C++ code that
normally appears within the S-function routines and the S-function itself that has been removed from
the build process.

A fully inlined S-function builds your algorithm (block) into generated code in a manner that is
indistinguishable from a built-in block. Typically, a fully inlined S-function requires you to implement
your algorithm twice: once for the Simulink model (C/C++ MEX S-function) and once for code
generation (TLC file). The complexity of the TLC file depends on the complexity of your algorithm and
the level of efficiency you try to achieve in the generated code. TLC files vary from simple to complex
in structure. See “Inlining S-Functions”.

Auto-generated S-Functions for Legacy or Custom Code

If you need to invoke hand-written C/C++ code in your model, consider using the Simulink Legacy
Code Tool. The Legacy Code Tool can automate the generation of a fully inlined S-function and a
corresponding TLC file based on information that you register in a Legacy Code Tool data structure.
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For more information, see “Integrate C Functions Using Legacy Code Tool” and see “Import Calls to
External Code into Generated Code with Legacy Code Tool” on page 13-6.

Files Required for Implementing Noninlined and Inlined S-Functions
This topic briefly describes what files and functions you need to create noninlined and inlined S-
functions.

• Noninlined S-functions require the C or C++ MEX S-function source code (sfunction.c or
sfunction.cpp).

• Fully inlined S-functions require an sfunction.tlc file. Fully inlined S-functions produce the
optimal code for a parameterized S-function. This is an S-function that operates in a specific mode
dependent upon fixed S-function parameters that do not change during model execution. For a
given operating mode, the sfunction.tlc file specifies the exact code that is generated to
implement the algorithm for that mode. For example, the direct-index lookup table S-function in
“Write Fully Inlined S-Functions with mdlRTW Routine” on page 13-106 contains two operating
modes — one for evenly spaced x-data and one for unevenly spaced x-data.

Note Fully inlined S-functions that are generated to invoke legacy or custom C/C++ code also
require an sfunction.tlc file, which is generated by Legacy Code Tool.

Fully inlined S-functions might require the placement of the mdlRTW routine in your S-function MEX-
file sfunction.c or sfunction.cpp. The mdlRTW routine lets you place information in
model.rtw. model.rtw is the record file that specifies a model, and which the code generator
invokes the Target Language Compiler to process before executing sfunction.tlc when
generating code.

Including a mdlRTW routine is useful when you want to introduce non-tunable parameters into your
TLC file. Such parameters are used to determine which operating mode is active in a given instance
of the S-function. Based on this information, the TLC file for the S-function can generate highly
efficient, optimal code for that operating mode.

Guidelines for Writing S-Functions that Support Code Generation
• You can use C/C++ MEX, MATLAB language, and Fortran MEX S-functions with code generation.
• You can inline S-functions for code generation by providing an inlining TLC file. See S-Function

Inlining in “Target Language Compiler”. MATLAB and Fortran MEX S-functions must be inlined.
C/C++ MEX S-functions can be inlined for code efficiency, or noninlined.

• To automatically generate a fully inlined C MEX S-function for invoking legacy or custom code,
use the Legacy Code Tool. For more information, see “Integrate C Functions Using Legacy Code
Tool” and see “Import Calls to External Code into Generated Code with Legacy Code Tool”.

• If code efficiency is not an overriding consideration, for example, if you are rapid prototyping, you
can choose not to inline a C/C++ MEX S-function. For more information, see “Write Noninlined S-
Function” on page 13-95.
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See Also

More About
• “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 13-6
• “Generate S-Function from Subsystem” on page 13-64
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Import Calls to External Code into Generated Code with Legacy
Code Tool

In this section...
“Legacy Code Tool and Code Generation” on page 13-6
“Generate Inlined S-Function Files for Code Generation” on page 13-6
“Apply Code Style Settings to Legacy Functions” on page 13-7
“Address Dependencies on Files in Different Locations” on page 13-8
“Deploy S-Functions for Simulation and Code Generation” on page 13-8
“Integrate External C++ Objects” on page 13-8

Legacy Code Tool and Code Generation
You can use the Simulink Legacy Code Tool to generate fully inlined C MEX S-functions for legacy or
custom code. The S-functions are optimized for embedded components, such as device drivers and
lookup tables, and they call existing C or C++ functions.

Note The Legacy Code Tool can interface with C++ functions, but not C++ objects. To work around
this issue so that the tool can interface with C++ objects, see “Legacy Code Tool Limitations”.

You can use the tool to:

• Compile and build the generated S-function for simulation.
• Generate a masked S-Function block that is configured to call the existing external code.

If you want to include these types of S-functions in models for which you intend to generate code, use
the tool to generate a TLC block file. The TLC block file specifies how the generated code for a model
calls the existing C or C++ function.

If the S-function depends on files in folders other than the folder containing the S-function
dynamically loadable executable file, use the tool to generate an sFunction_makecfg.m or
rtwmakecfg.m file for the S-function. Generating the file maintains those dependencies when you
build a model that includes the S-function. For example, for some applications, such as custom
targets, you might want to locate files in a target-specific location. The build process looks for
sFunction_makecfg.m or rtwmakecfg.m in the same folder as the S-function dynamically loadable
executable and calls the function in the file.

For more information, see “Integrate C Functions Using Legacy Code Tool”.

Generate Inlined S-Function Files for Code Generation
Depending on the code generation requirements of your application, to generate code for a model
that uses the S-function, do either of the following:

• Generate one .cpp file for the inlined S-function. In the Legacy Code Tool data structure, set the
value of the Options.singleCPPMexFile field to true before generating the S-function source
file from your existing C function. For example:
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def.Options.singleCPPMexFile = true;
legacy_code('sfcn_cmex_generate', def);

• Generate a source file and a TLC block file for the inlined S-function. For example:

def.Options.singleCPPMexFile = false;
legacy_code('sfcn_cmex_generate', def);
legacy_code('sfcn_tlc_generate', def);

singleCPPMexFile Limitations

You cannot set the singleCPPMexFile field to true if

• Options.language='C++'
• You use one of the following Simulink objects with the IsAlias property set to true:

• Simulink.Bus
• Simulink.AliasType
• Simulink.NumericType

• The Legacy Code Tool function specification includes a void* or void** to represent scalar work
data for a state argument

• HeaderFiles field of the Legacy Code Tool structure specifies multiple header files

Apply Code Style Settings to Legacy Functions
To apply the model configuration parameters for code style to a legacy function:

1 Initialize the Legacy Code Tool data structure. For example:

def = legacy_code('initialize');
2 In the data structure, set the value of the Options.singleCPPMexFile field to true. For

example:

def.Options.singleCPPMexFile = true;

To check the setting, enter:

def.Options.singleCPPMexFile

singleCPPMexFile Limitations

You cannot set the singleCPPMexFile field to true if

• Options.language='C++'
• You use one of the following Simulink objects with the IsAlias property set to true:

• Simulink.Bus
• Simulink.AliasType
• Simulink.NumericType

• The Legacy Code Tool function specification includes a void* or void** to represent scalar work
data for a state argument

• HeaderFiles field of the Legacy Code Tool structure specifies multiple header files
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Address Dependencies on Files in Different Locations
By default, the Legacy Code Tool assumes that files on which an S-function depends reside in the
same folder as the dynamically loadable executable file for the S-function. If your S-function depends
on files that reside elsewhere and you are using the template makefile build process, generate an
sFunction_makecfg.m or rtwmakecfg.m file for the S-function. For example, you might generate
this file if your Legacy Code Tool data structure defines compilation resources as path names.

To generate the sFunction_makecfg.m or rtwmakecfg.m file, call the legacy_code function with
'sfcn_makecfg_generate' or 'rtwmakecfg_generate' as the first argument, and the name of
the Legacy Code Tool data structure as the second argument. For example:

legacy_code('sfcn_makecfg_generate', lct_spec);

If you use multiple registration files in the same folder and generate an S-function for each file with a
single call to legacy_code, the call to legacy_code that specifies 'sfcn_makecfg_generate' or
'rtwmakecfg_generate' must be common to all registration files. For more information, see
“Handling Multiple Registration Files”.

For example, if you define defs as an array of Legacy Code Tool structures, you call legacy_code
with 'sfcn_makecfg_generate' once.

defs = [defs1(:);defs2(:);defs3(:)];
legacy_code('sfcn_makecfg_generate', defs);

For more information, see “Build Support for S-Functions”.

Deploy S-Functions for Simulation and Code Generation
You can deploy the S-functions that you generate with the Legacy Code Tool so that other people can
use them. To deploy an S-function for simulation and code generation, share the following files:

• Registration file
• Compiled dynamically loadable executable
• TLC block file
• sFunction_makecfg.m or rtwmakecfg.m file
• Header, source, and include files on which the generated S-function depends

When you use these deployed files:

• Before using the deployed files in a Simulink model, add the folder that contains the S-function
files to the MATLAB path.

• If the Legacy Code Tool data structure registers required files as absolute paths and the location
of the files changes, regenerate the sFunction_makecfg.m or rtwmakecfg.m file.

Integrate External C++ Objects
The Legacy Code Tool can interface with C++ functions, but not C++ objects. Using the previous
example as a starting point, here is an example of how you can work around this limitation.

• Modify the class definition for adder in a new file adder_cpp.hpp. Add three new macros that
dynamically allocate a new adder object, invoke the method add_one(), and free the memory
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allocated. Each macro takes a pointer to an adder object. Because each function called by the
Legacy Code Tool must have a C-like signature, the pointer is cached and passed as a void*. Then
you must explicitly cast to adder* in the macro. The new class definition for adder:

#ifndef _ADDER_CPP_
#define _ADDER_CPP_

class adder {
private:
    int int_state;
public:
    adder(): int_state(0) {};
    int add_one(int increment);
    int get_val() {return int_state;};
};

// Method wrappers implemented as macros
#define createAdder(work1) \
    *(work1) = new adder

#define deleteAdder(work1) \
    delete(static_cast<adder*>(*(work1)))

#define adderOutput(work1, u1) \
    (static_cast<adder*> ((work1)))->add_one(u1)

#endif /* _ADDER_CPP_ */
• Update adder_cpp.cpp. With the class modification, instead of one global instance, each

generated S-function manages its own adder object.

#include "adder_cpp.hpp"

int adder::add_one(int increment)
{
    int_state += increment;
    return int_state;
}

• Update rtwdemo_sfun_adder_cpp.cpp with the following changes:

• StartFcnSpec calls the macro that allocates a new adder object and caches the pointer.

def.StartFcnSpec  = 'createAdder(void **work1)';
• OutputFcnSpec calls the macro that invokes the method add_one() and provides the S-

function specific adder pointer object.

def.OutputFcnSpec = 'int32 y1 = adderOutput(void *work1, int32 u1)';
• TerminateFcnSpec calls the macro that frees the memory.

def.TerminateFcnSpec = 'deleteAdder(void **work1)';

See Also
legacy_code
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Related Examples
• “Integrate C Functions Using Legacy Code Tool”
• “Legacy Code Tool Examples”
• “Call External C Code from Model and Generated Code” on page 51-47
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Legacy Code Tool Examples
You can use the Simulink Legacy Code Tool to generate fully inlined C MEX S-functions for legacy or
custom code. The S-functions are optimized for embedded components, such as device drivers and
lookup tables, and they call existing C or C++ functions. These examples show how to use the Legacy
Code Tool to integrate a variety of external functions.

Integrate External C Functions That Pass Input Arguments By Value
Versus Address
This example shows how to use the Legacy Code Tool to integrate legacy C functions that pass their
input arguments by value versus address.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototypes of the legacy functions being called in this example are:

• FLT filterV1(const FLT signal, const FLT prevSignal, const FLT gain)
• FLT filterV2(const FLT* signal, const FLT prevSignal, const FLT gain)

FLT is a typedef to float. The legacy source code is in the files your_types.h, myfilter.h, filterV1.c, and
filterV2.c.

Note the difference in the OutputFcnSpec defined in the two structures; the first case specifies that
the first input argument is passed by value, while the second case specifies pass by pointer.

defs = [];

% rtwdemo_sfun_filterV1
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_filterV1';
def.OutputFcnSpec = 'single y1 = filterV1(single u1, single u2, single p1)';
def.HeaderFiles   = {'myfilter.h'};
def.SourceFiles   = {'filterV1.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_filterV2
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_filterV2';
def.OutputFcnSpec = 'single y1 = filterV2(single u1[1], single u2, single p1)';
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def.HeaderFiles   = {'myfilter.h'};
def.SourceFiles   = {'filterV2.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-functions
call the legacy functions in simulation. The source code for the S-functions is in the files
rtwdemo_sfun_filterV1.c and rtwdemo_sfun_filterV2.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_filterV1
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19632214', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp1a1b2c7a_1416_4e5c_b4a4_50315e43b7d9', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\filterV1.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_filterV1.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19632214', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp1a1b2c7a_1416_4e5c_b4a4_50315e43b7d9\filterV1.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_filterV1
### Exit

### Start Compiling rtwdemo_sfun_filterV2
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19632214', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp37d2b566_d674_489f_a73a_efa9567091be', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\filterV2.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_filterV2.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19632214', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp37d2b566_d674_489f_a73a_efa9567091be\filterV2.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_filterV2
### Exit

Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how
the generated code for a model calls the legacy code. If you do not generate TLC block files and you
try to generate code for a model that includes the S-functions, code generation fails. The TLC block
files for the S-functions are rtwdemo_sfun_filterV1.tlc and rtwdemo_sfun_filterV2.tlc.

legacy_code('sfcn_tlc_generate', defs);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-functions are not in the same folder as the S-functions, and

13 Block Authoring and Code Generation for Simulink Coder

13-12



you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', defs);

Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate masked S-function blocks that call the S-functions.
The software places the blocks in a new model. From there you can copy them to an existing model.

legacy_code('slblock_generate', defs);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_filter shows integration of the model with the legacy code. The subsystem
TestFilter serves as a harness for the calls to the legacy C functions via the generate S-functions, with
unit delays serving to store the previous output values.

open_system('rtwdemo_lct_filter')
open_system('rtwdemo_lct_filter/TestFilter')
sim('rtwdemo_lct_filter')
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Integrate External C Functions That Pass the Output Argument As a
Return Argument
This example shows how to use the Legacy Code Tool to integrate legacy C functions that pass their
output as a return argument.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

FLT gainScalar(const FLT in, const FLT gain)

FLT is a typedef to float. The legacy source code is in the files your_types.h, gain.h, and gainScalar.c.

% rtwdemo_sfun_gain_scalar
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_gain_scalar';
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def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_gain_scalar.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_gain_scalar
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex09148220', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp41869fb7_e14f_4061_9af0_8695aa2e6840', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\gainScalar.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_gain_scalar.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex09148220', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp41869fb7_e14f_4061_9af0_8695aa2e6840\gainScalar.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_gain_scalar
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_gain_scalar.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
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function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_gain shows integration of the model with the legacy code. The subsystem
TestGain serves as a harness for the call to the legacy C function via the generate S-function.

open_system('rtwdemo_lct_gain')
open_system('rtwdemo_lct_gain/TestGain')
sim('rtwdemo_lct_gain')

Integrate External C++ Object Methods
Integrate legacy C++ object methods by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C++ MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a block TLC file and optional rtwmakecfg.m file that calls the legacy code during code

generation.

Provide the Legacy Function Specification

Functions provided with the Legacy Code Tool take a specific data structure or array of structures as
the argument. The data structure is initialized by calling the function legacy_code() using 'initialize'
as the first input. After initializing the structure, assign its properties to values corresponding to the
legacy code being integrated. The definition of the legacy C++ class in this example is:

class adder {
  private:
      int int_state;
  public:
      adder();
      int add_one(int increment);
      int get_val();
};

The legacy source code is in the files adder_cpp.h and adder_cpp.cpp.
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% rtwdemo_sfun_adder_cpp
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_adder_cpp';
def.StartFcnSpec  = 'createAdder()';
def.OutputFcnSpec = 'int32 y1 = adderOutput(int32 u1)';
def.TerminateFcnSpec = 'deleteAdder()';
def.HeaderFiles   = {'adder_cpp.h'};
def.SourceFiles   = {'adder_cpp.cpp'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
def.Options.language = 'C++';
def.Options.useTlcWithAccel = false;

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_adder_cpp.cpp.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_adder_cpp
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex06428671', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp80aa2f94_2487_4318_8062_23844b4992e4', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\adder_cpp.cpp')
Building with 'Microsoft Visual C++ 2019'.
MEX completed successfully.
    mex('rtwdemo_sfun_adder_cpp.cpp', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex06428671', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp80aa2f94_2487_4318_8062_23844b4992e4\adder_cpp.obj')
Building with 'Microsoft Visual C++ 2019'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_adder_cpp
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file that supports code
generation through Simulink® Coder™. If the TLC block file is not created and you try to generate
code for a model that includes the S-function, code generation fails. The TLC block file for the S-
function is: rtwdemo_sfun_adder_cpp.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again. Set the first input to
'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code generation through
Simulink® Coder™. If the required source and header files for the S-function are not in the same
folder as the S-function, and you want to add these dependencies in the makefile produced during
code generation, generate the rtwmakecfg.m file.
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legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the
first input to 'slblock_generate' to generate a masked S-function block that is configured to call that
S-function. The software places the block in a new model. You can copy the block to an existing
model.

% legacy_code('slblock_generate', def);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_cpp shows integration with the legacy code.

open_system('rtwdemo_lct_cpp')
sim('rtwdemo_lct_cpp')

Integrate External C Functions That Pass Input and Output Arguments
as Parameters with a Fixed-Point Data Type
Integrate legacy C functions that pass their inputs and outputs by using parameters of a fixed-point
data type with the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.
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Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

myFixpt timesS16(const myFixpt in1, const myFixpt in2, const uint8_T fracLength)

myFixpt is logically a fixed point data type, which is physically a typedef to a 16-bit integer:

myFixpt = Simulink.NumericType;
myFixpt.DataTypeMode = 'Fixed-point: binary point scaling';
myFixpt.Signed = true;
myFixpt.WordLength = 16;
myFixpt.FractionLength = 10;
myFixpt.IsAlias = true;
myFixpt.HeaderFile = 'timesFixpt.h';

The legacy source code is in the files timesFixpt.h, and timesS16.c.

% rtwdemo_sfun_gain_fixpt
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_gain_fixpt';
def.OutputFcnSpec = 'myFixpt y1 = timesS16(myFixpt u1, myFixpt p1, uint8 p2)';
def.HeaderFiles   = {'timesFixpt.h'};
def.SourceFiles   = {'timesS16.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_gain_fixpt.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_gain_fixpt
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex05928773', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp1b06328a_eeee_4737_ba6e_0e8b3deeeb93', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\timesS16.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_gain_fixpt.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex05928773', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp1b06328a_eeee_4737_ba6e_0e8b3deeeb93\timesS16.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_gain_fixpt
### Exit
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Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies
how the generated code for a model calls the legacy code. If you do not generate a TLC block file and
you try to generate code for a model that includes the S-function, code generation fails. The TLC
block file for the S-function is: rtwdemo_sfun_gain_fixpt.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again. Set the first input to
'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the
first input to 'slblock_generate' to generate a masked S-function block that calls that S-function. The
software places the block in a new model. You can copy the block to an existing model.

legacy_code('slblock_generate', def);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_fixpt_params shows integration of the model with the legacy code. The
subsystem TestFixpt serves as a harness for the call to the legacy C function via the generated S-
function.

open_system('rtwdemo_lct_fixpt_params')
open_system('rtwdemo_lct_fixpt_params/TestFixpt')
sim('rtwdemo_lct_fixpt_params')

13 Block Authoring and Code Generation for Simulink Coder

13-20

matlab:rtwdemo_lct_fixpt_params


Integrate External C Functions That Pass Input and Output Arguments
as Signals with a Fixed-Point Data Type
This example shows how to use the Legacy Code Tool to integrate legacy C functions that pass their
inputs and outputs by using parameters of fixed-point data type.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

myFixpt timesS16(const myFixpt in1, const myFixpt in2, const uint8_T fracLength)

myFixpt is logically a fixed-point data type, which is physically a typedef to a 16-bit integer:

myFixpt = Simulink.NumericType;
myFixpt.DataTypeMode = 'Fixed-point: binary point scaling';
myFixpt.Signed = true;
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myFixpt.WordLength = 16;
myFixpt.FractionLength = 10;
myFixpt.IsAlias = true;
myFixpt.HeaderFile = 'timesFixpt.h';

The legacy source code is in the files timesFixpt.h, and timesS16.c.

% rtwdemo_sfun_times_s16
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_times_s16';
def.OutputFcnSpec = 'myFixpt y1 = timesS16(myFixpt u1, myFixpt u2, uint8 p1)';
def.HeaderFiles   = {'timesFixpt.h'};
def.SourceFiles   = {'timesS16.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_times_s16.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_times_s16
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex96454812', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp9190602b_bc92_4260_91f5_d33623400b69', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\timesS16.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_times_s16.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex96454812', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp9190602b_bc92_4260_91f5_d33623400b69\timesS16.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_times_s16
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_times_s16.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
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you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Show the Integration of the Model with Legacy Code

The model rtwdemo_lct_fixpt_signals shows integration of the model with the legacy code. The
subsystem TestFixpt serves as a harness for the call to the legacy C function via the generated S-
function.

open_system('rtwdemo_lct_fixpt_signals')
open_system('rtwdemo_lct_fixpt_signals/TestFixpt')
sim('rtwdemo_lct_fixpt_signals')

Integrate External C Functions with Instance-Specific Persistent
Memory
Integrate legacy C functions that use instance-specific persistent memory by using the Legacy Code
Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.
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Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototypes of the legacy functions being called in this example are:

void memory_bus_init(COUNTERBUS *mem, int32_T upper_sat, int32_T lower_sat);

void memory_bus_step(COUNTERBUS *input, COUNTERBUS *mem, COUNTERBUS *output);

mem is an instance-specific persistent memory for applying a one integration step delay.
COUNTERBUS is a struct typedef defined in counterbus.h and implemented with a Simulink.Bus
object in the base workspace. The legacy source code is in the files memory_bus.h, and
memory_bus.c.

evalin('base','load rtwdemo_lct_data.mat')

% rtwdemo_sfun_work
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_work';
def.InitializeConditionsFcnSpec = ...
    'void memory_bus_init(COUNTERBUS work1[1], int32 p1, int32 p2)';
def.OutputFcnSpec = ...
    'void memory_bus_step(COUNTERBUS u1[1], COUNTERBUS work1[1], COUNTERBUS y1[1])';
def.HeaderFiles   = {'memory_bus.h'};
def.SourceFiles   = {'memory_bus.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_work.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_work
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex38707886', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpdea65aad_8372_48b7_a43c_dc9df811a561', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\memory_bus.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_work.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex38707886', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpdea65aad_8372_48b7_a43c_dc9df811a561\memory_bus.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_work
### Exit
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Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_work.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Show the Integration of the Model with Legacy Code

The model rtwdemo_lct_work shows integration of the model with the legacy code. The subsystem
memory_bus serves as a harness for the call to the legacy C function.

open_system('rtwdemo_lct_work')
open_system('rtwdemo_lct_work/memory_bus')
sim('rtwdemo_lct_work')

Integrate External C Functions That Use Structure Arguments
Integrate legacy C functions with structure arguments that use Simulink® buses with the Legacy
Code Tool.

With the Legacy Code Tool, you can:
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• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

counterbusFcn(COUNTERBUS *u1, int32_T u2, COUNTERBUS *y1, int32_T *y2)

COUNTERBUS is a struct typedef defined in counterbus.h and implemented with a Simulink.Bus
object in the base workspace. The legacy source code is in the files counterbus.h, and counterbus.c.

evalin('base','load rtwdemo_lct_data.mat')

% rtwdemo_sfun_counterbus
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_counterbus';
def.OutputFcnSpec = ...
    'void counterbusFcn(COUNTERBUS u1[1], int32 u2, COUNTERBUS y1[1], int32 y2[1])';
def.HeaderFiles   = {'counterbus.h'};
def.SourceFiles   = {'counterbus.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_counterbus.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_counterbus
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex90330074', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp265d1f2b_94df_4343_8529_23c3c59e2080', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\counterbus.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_counterbus.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex90330074', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp265d1f2b_94df_4343_8529_23c3c59e2080\counterbus.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_counterbus
### Exit
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Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_counterbus.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Show the Integration of the Model with Legacy Code

The model rtwdemo_lct_bus shows integration of the model with the legacy code. The subsystem
TestCounter serves as a harness for the call to the legacy C function.

open_system('rtwdemo_lct_bus')
open_system('rtwdemo_lct_bus/TestCounter')
sim('rtwdemo_lct_bus')

 Legacy Code Tool Examples

13-27

matlab:rtwdemo_lct_bus


Integrate External C Functions That Pass Input and Output Arguments
as Signals with Complex Data
Integrate legacy C functions using complex signals with the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

void cplx_gain(creal_T *input, creal_T *gain, creal_T *output);

creal_T is the complex representation of a double. The legacy source code is in the files cplxgain.h,
and cplxgain.c.

% rtwdemo_sfun_gain_scalar
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_cplx_gain';
def.OutputFcnSpec = ...
    ['void cplx_gain(complex<double> u1[1], '...
    'complex<double> p1[1], complex<double> y1[1])'];
def.HeaderFiles   = {'cplxgain.h'};
def.SourceFiles   = {'cplxgain.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_cplx_gain.c.

legacy_code('sfcn_cmex_generate', def);
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Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_cplx_gain
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex97344681', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpf6ba660b_ff00_484c_a5e5_76ac4779265f', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\cplxgain.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_cplx_gain.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex97344681', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpf6ba660b_ff00_484c_a5e5_76ac4779265f\cplxgain.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_cplx_gain
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_cplx_gain.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Show the Integration of the Model with Legacy Code

The model rtwdemo_lct_cplxgain shows integration of the model with the legacy code. The subsystem
complex_gain serves as a harness for the call to the legacy C function via the generate S-function.
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if isempty(find_system('SearchDepth',0,'Name','rtwdemo_lct_cplxgain'))
    open_system('rtwdemo_lct_cplxgain')
    open_system('rtwdemo_lct_cplxgain/complex_gain')
    sim('rtwdemo_lct_cplxgain')
end

Integrate External C Functions That Pass Arguments That Have
Inherited Dimensions
This example shows how to use the Legacy Code Tool to integrate legacy C functions whose
arguments have inherited dimensions.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototypes of the legacy functions being called in this example are:

• void mat_add(real_T *u1, real_T *u2, int32_T nbRows, int32_T nbCols, real_T *y1)
• void mat_mult(real_T *u1, real_T *u2, int32_T nbRows1, int32_T nbCols1, int32_T nbCols2, real_T

*y1)

real_T is a typedef to double, and int32_T is a typedef to a 32-bit integer. The legacy source code is in
the files mat_ops.h, and mat_ops.c.

defs = [];

% rtwdemo_sfun_mat_add
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_mat_add';
def.OutputFcnSpec = ['void mat_add(double u1[][], double u2[][], ' ...
                   'int32 u3, int32 u4, double y1[size(u1,1)][size(u1,2)])'];
def.HeaderFiles   = {'mat_ops.h'};
def.SourceFiles   = {'mat_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_mat_mult
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def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_mat_mult';
def.OutputFcnSpec =  ['void mat_mult(double u1[p1][p2], double u2[p2][p3], '...
                   'int32 p1, int32 p2, int32 p3, double y1[p1][p3])'];
def.HeaderFiles   = {'mat_ops.h'};
def.SourceFiles   = {'mat_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-functions
call the legacy functions during simulation. The source code for the S-function is in the files
rtwdemo_sfun_mat_add.c and rtwdemo_sfun_mat_mult.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_mat_add
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex89794148', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp6da6c28c_5cbd_44c0_b20b_a11f59fc94b5', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\mat_ops.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_mat_add.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex89794148', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp6da6c28c_5cbd_44c0_b20b_a11f59fc94b5\mat_ops.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_mat_add
### Exit

### Start Compiling rtwdemo_sfun_mat_mult
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex89794148', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp5c0ebe4a_aa26_419e_b412_d85c246f5b6e', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\mat_ops.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_mat_mult.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex89794148', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp5c0ebe4a_aa26_419e_b412_d85c246f5b6e\mat_ops.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_mat_mult
### Exit

Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how
the generated code for a model calls the legacy code. If you do not generate TLC block files and you
try to generate code for a model that includes the S-functions, code generation fails. The TLC block
files for the S-functions are rtwdemo_sfun_mat_add.tlc and rtwdemo_sfun_mat_mult.tlc.

legacy_code('sfcn_tlc_generate', defs);
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Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-functions are not in the same folder as the S-functions, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', defs);

Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate masked S-function blocks that call the S-functions.
The software places the blocks in a new model. From there you can copy them to an existing model

legacy_code('slblock_generate', defs);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_inherit_dims shows integration of the model with the legacy code. The
subsystem TestMatOps serves as a harness for the calls to the legacy C functions, with unit delays
serving to store the previous output values.

open_system('rtwdemo_lct_inherit_dims')
open_system('rtwdemo_lct_inherit_dims/TestMatOps')
sim('rtwdemo_lct_inherit_dims')
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Integrate External C Functions That Pass Arguments as Multi-
Dimensional Signals
This example shows how to use the Legacy Code Tool to integrate legacy C functions with multi-
dimensional Signals.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

void array3d_add(real_T *y1, real_T *u1, real_T *u2, int32_T nbRows, int32_T nbCols, int32_T
nbPages);

real_T is a typedef to double, and int32_T is a typedef to a 32-bit integer. The legacy source code is in
the files ndarray_ops.h, and ndarray_ops.c.

% rtwdemo_sfun_ndarray_add
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_ndarray_add';
def.OutputFcnSpec =...
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    ['void array3d_add(double y1[size(u1,1)][size(u1,2)][size(u1,3)], ',...
    'double u1[][][], double u2[][][], ' ...
    'int32 size(u1,1), int32 size(u1,2), int32 size(u1,3))'];
def.HeaderFiles   = {'ndarray_ops.h'};
def.SourceFiles   = {'ndarray_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

y1 is a 3-D output signal of same dimensions as the 3-D input signal u1. Note that the last 3
arguments passed to the legacy function correspond to the number of element in each dimension of
the 3-D input signal u1.

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_ndarray_add.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_ndarray_add
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex14927435', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpeab3c4cb_efd3_4e6a_b6c2_4da44b4a1032', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\ndarray_ops.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_ndarray_add.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex14927435', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpeab3c4cb_efd3_4e6a_b6c2_4da44b4a1032\ndarray_ops.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_ndarray_add
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_ndarray_add.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);
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Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Showing the Generated Integration with Legacy Code

The model rtwdemo_lct_ndarray shows integration of the model with the legacy code. The subsystem
ndarray_add serves as a harness for the call to the legacy C function.

open_system('rtwdemo_lct_ndarray')
open_system('rtwdemo_lct_ndarray/ndarray_add')
sim('rtwdemo_lct_ndarray')

Integrate External C Functions That Implement Start and Terminate
Actions
Integrate legacy C functions that have start and terminate actions by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototypes of the legacy functions being called in this example are:
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• void initFaultCounter(unsigned int *counter)
• void openLogFile(void **fid)
• void incAndLogFaultCounter(void *fid, unsigned int *counter, double time)
• void closeLogFile(void **fid)

The legacy source code is in the files your_types.h, fault.h, and fault.c.

% rtwdemo_sfun_fault
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_fault';
def.InitializeConditionsFcnSpec  = 'initFaultCounter(uint32 work2[1])';
def.StartFcnSpec                 = 'openLogFile(void **work1)';
def.OutputFcnSpec                = ...
    'incAndLogFaultCounter(void *work1, uint32 work2[1], double u1)';
def.TerminateFcnSpec             = 'closeLogFile(void **work1)';
def.HeaderFiles                  = {'fault.h'};
def.SourceFiles                  = {'fault.c'};
def.IncPaths                     = {'rtwdemo_lct_src'};
def.SrcPaths                     = {'rtwdemo_lct_src'};
def.Options.useTlcWithAccel      = false;

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_fault.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_fault
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex46254423', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpbd2a2c96_cad5_4ba1_90c2_c8c96fff716f', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\fault.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_fault.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex46254423', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpbd2a2c96_cad5_4ba1_90c2_c8c96fff716f\fault.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_fault
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_fault.tlc.

legacy_code('sfcn_tlc_generate', def);
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Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Showing the Generated Integration with Legacy Code

The model rtwdemo_lct_start_term shows integration of the model with the legacy code. The
subsystem TestFixpt serves as a harness for the call to the legacy C function, and the scope compares
the output of the function with the output of the built-in Simulink® product block; the results should
be identical.

open_system('rtwdemo_lct_start_term')
open_system('rtwdemo_lct_start_term/TestFault')
sim('rtwdemo_lct_start_term')

Integrate External C Functions That Implement N-Dimensional Table
Lookups
Integrate legacy C functions that implement N-dimensional table lookups by using the Legacy Code
Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
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• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

FLT directLookupTableND(const FLT *tableND, const UINT32 nbDims, const UINT32 *tableDims,
const UINT32 *tableIdx)

FLT is a typedef to float, and UINT32 is a typedef to unsigned int32. The legacy source code is in the
files your_types.h, lookupTable.h, and directLookupTableND.c.

defs = [];
evalin('base','load rtwdemo_lct_data.mat')

% rtwdemo_sfun_dlut3D
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_dlut3D';
def.OutputFcnSpec = 'single y1 = DirectLookupTable3D(single p1[][][], uint32 p2[3], uint32 u1[3])';
def.HeaderFiles   = {'lookupTable.h'};
def.SourceFiles   = {'directLookupTableND.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_dlut4D
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_dlut4D';
def.OutputFcnSpec = 'single y1 = DirectLookupTable4D(single p1[][][][], uint32 p2[4], uint32 u1[4])';
def.HeaderFiles   = {'lookupTable.h'};
def.SourceFiles   = {'directLookupTableND.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs',
call the function legacy_code() again. Set the first input to 'sfcn_cmex_generate'. The S-functions call
the legacy functions during simulation. The source code for the S-functions is in the files
rtwdemo_sfun_dlut3D.c and rtwdemo_sfun_dlut4D.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with
Simulink®, call the function legacy_code() again. Set the first input to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_dlut3D
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    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp88c2b065_4d32_40b8_b17a_d441c55f53b5', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\directLookupTableND.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_dlut3D.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp88c2b065_4d32_40b8_b17a_d441c55f53b5\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_dlut3D
### Exit

### Start Compiling rtwdemo_sfun_dlut4D
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpf5f4320d_ca53_49eb_999d_061524c690ea', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\directLookupTableND.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_dlut4D.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpf5f4320d_ca53_49eb_999d_061524c690ea\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_dlut4D
### Exit

Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function legacy_code()
again. Set the first input to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how the
generated code for a model calls the legacy code. If you do not generate TLC block files and you try
to generate code for a model that includes the S-functions, code generation fails. The TLC block files
for the S-functions are rtwdemo_sfun_dlut3D.tlc and rtwdemo_sfun_dlut4D.tlc.

legacy_code('sfcn_tlc_generate', defs);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function legacy_code() again. Set the first input
to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-functions are not in the same folder as the S-functions, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', defs);

Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the
first input to 'slblock_generate' to generate masked S-function blocks that call the S-functions. The
software places the blocks in a new model. You can copy the blocks to an existing model.

legacy_code('slblock_generate', defs);
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Show the Generated Integration with Legacy Code

The model rtwdemo_lct_lut shows integration of the model with the legacy code. The subsystem
TestFixpt serves as a harness for the call to the legacy C function, and the Display blocks compare the
output of the function with the output of the built-in Simulink® lookup blocks. The results are
identical.

open_system('rtwdemo_lct_lut')
open_system('rtwdemo_lct_lut/TestLut1')
sim('rtwdemo_lct_lut')

Integrate External C Functions That Pass Arguments as Multi-
Dimensional Signals
This example shows how to use the Legacy Code Tool to integrate legacy C functions with multi-
dimensional Signals.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

void array3d_add(real_T *y1, real_T *u1, real_T *u2, int32_T nbRows, int32_T nbCols, int32_T
nbPages);
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real_T is a typedef to double, and int32_T is a typedef to a 32-bit integer. The legacy source code is in
the files ndarray_ops.h, and ndarray_ops.c.

% rtwdemo_sfun_ndarray_add
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_ndarray_add';
def.OutputFcnSpec =...
    ['void array3d_add(double y1[size(u1,1)][size(u1,2)][size(u1,3)], ',...
    'double u1[][][], double u2[][][], ' ...
    'int32 size(u1,1), int32 size(u1,2), int32 size(u1,3))'];
def.HeaderFiles   = {'ndarray_ops.h'};
def.SourceFiles   = {'ndarray_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

y1 is a 3-D output signal of same dimensions as the 3-D input signal u1. Note that the last 3
arguments passed to the legacy function correspond to the number of element in each dimension of
the 3-D input signal u1.

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_ndarray_add.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_ndarray_add
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex14927435', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpeab3c4cb_efd3_4e6a_b6c2_4da44b4a1032', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\ndarray_ops.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_ndarray_add.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex14927435', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpeab3c4cb_efd3_4e6a_b6c2_4da44b4a1032\ndarray_ops.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_ndarray_add
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file
specifies how the generated code for a model calls the legacy code. If you do not generate a TLC
block file and you try to generate code for a model that includes the S-function, code generation fails.
The TLC block file for the S-function is: rtwdemo_sfun_ndarray_add.tlc.

legacy_code('sfcn_tlc_generate', def);
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Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-
function. The software places the block in a new model. From there you can copy it to an existing
model.

legacy_code('slblock_generate', def);

Showing the Generated Integration with Legacy Code

The model rtwdemo_lct_ndarray shows integration of the model with the legacy code. The subsystem
ndarray_add serves as a harness for the call to the legacy C function.

open_system('rtwdemo_lct_ndarray')
open_system('rtwdemo_lct_ndarray/ndarray_add')
sim('rtwdemo_lct_ndarray')

Integrate External C Functions with a Block Sample Time Specified,
Inherited, and Parameterized
This example shows how to use the Legacy Code Tool to integrate legacy C functions with the block's
sample time specified, inherited and parameterized.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
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• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

FLT gainScalar(const FLT in, const FLT gain)

FLT is a typedef to float. The legacy source code is in the files your_types.h, gain.h, and gainScalar.c.

defs = [];

% rtwdemo_sfun_st_inherited
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_st_inherited';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_st_fixed
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_st_fixed';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
def.SampleTime    = [2 1];
defs = [defs; def];

% rtwdemo_sfun_st_parameterized
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_st_parameterized';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
def.SampleTime    = 'parameterized';
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-functions
call the legacy functions during simulation. The source code for the S-functions is in the files
rtwdemo_sfun_st_inherited.c and rtwdemo_sfun_st_fixed.c. rtwdemo_sfun_st_parameterized.c.

legacy_code('sfcn_cmex_generate', defs);
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Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_st_inherited
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex74504488', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpd9ab99a4_8e77_4e2d_b4d5_fa39ab6b08ab', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\gainScalar.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_st_inherited.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex74504488', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpd9ab99a4_8e77_4e2d_b4d5_fa39ab6b08ab\gainScalar.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_st_inherited
### Exit

### Start Compiling rtwdemo_sfun_st_fixed
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex74504488', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpe69bf6a5_232a_43e0_888e_9a0f05e50e1a', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\gainScalar.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_st_fixed.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex74504488', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpe69bf6a5_232a_43e0_888e_9a0f05e50e1a\gainScalar.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_st_fixed
### Exit

### Start Compiling rtwdemo_sfun_st_parameterized
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex74504488', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpb2d0c430_a98b_4c8f_91c4_a85b6923a64e', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\gainScalar.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_st_parameterized.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex74504488', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpb2d0c430_a98b_4c8f_91c4_a85b6923a64e\gainScalar.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_st_parameterized
### Exit

Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function legacy_code()
again with the first input set to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how
the generated code for a model calls the legacy code. If you do not generate TLC block files and you
try to generate code for a model that includes the S-functions, code generation fails. The TLC block
files for the S-functions are rtwdemo_sfun_st_inherited.tlc and rtwdemo_sfun_st_fixed.tlc.
rtwdemo_sfun_st_parameterized.tlc.

legacy_code('sfcn_tlc_generate', defs);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function legacy_code() again with the first input
set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-functions are not in the same folder as the S-functions, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', defs);
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Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function legacy_code() again with
the first input set to 'slblock_generate' to generate masked S-function blocks that call the S-functions.
The software places the blocks in a new model. From there you can copy them to an existing model.

legacy_code('slblock_generate', defs);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_sampletime shows integration of the model with the legacy code. The
subsystem sample_time serves as a harness for the calls to the legacy C functions, with unit delays
serving to store the previous output values.

open_system('rtwdemo_lct_sampletime')
open_system('rtwdemo_lct_sampletime/sample_time')
sim('rtwdemo_lct_sampletime')

See Also
legacy_code
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Related Examples
• “Import Calls to External Code into Generated Code with Legacy Code Tool”
• “Integrate C Functions Using Legacy Code Tool”
• “Call External C Code from Model and Generated Code” on page 51-47

13 Block Authoring and Code Generation for Simulink Coder

13-46



Integrate External C Functions That Pass Input and Output
Arguments as Parameters with a Fixed-Point Data Type

Integrate legacy C functions that pass their inputs and outputs by using parameters of a fixed-point
data type with the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

myFixpt timesS16(const myFixpt in1, const myFixpt in2, const uint8_T fracLength)

myFixpt is logically a fixed point data type, which is physically a typedef to a 16-bit integer:

myFixpt = Simulink.NumericType;
myFixpt.DataTypeMode = 'Fixed-point: binary point scaling';
myFixpt.Signed = true;
myFixpt.WordLength = 16;
myFixpt.FractionLength = 10;
myFixpt.IsAlias = true;
myFixpt.HeaderFile = 'timesFixpt.h';

The legacy source code is in the files timesFixpt.h, and timesS16.c.

% rtwdemo_sfun_gain_fixpt
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_gain_fixpt';
def.OutputFcnSpec = 'myFixpt y1 = timesS16(myFixpt u1, myFixpt p1, uint8 p2)';
def.HeaderFiles   = {'timesFixpt.h'};
def.SourceFiles   = {'timesS16.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_gain_fixpt.c.

legacy_code('sfcn_cmex_generate', def);
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Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_gain_fixpt
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex05928773', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp1b06328a_eeee_4737_ba6e_0e8b3deeeb93', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\timesS16.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_gain_fixpt.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex05928773', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp1b06328a_eeee_4737_ba6e_0e8b3deeeb93\timesS16.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_gain_fixpt
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies
how the generated code for a model calls the legacy code. If you do not generate a TLC block file and
you try to generate code for a model that includes the S-function, code generation fails. The TLC
block file for the S-function is: rtwdemo_sfun_gain_fixpt.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again. Set the first input to
'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code generation. If the
required source and header files for the S-function are not in the same folder as the S-function, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the
first input to 'slblock_generate' to generate a masked S-function block that calls that S-function. The
software places the block in a new model. You can copy the block to an existing model.

legacy_code('slblock_generate', def);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_fixpt_params shows integration of the model with the legacy code. The
subsystem TestFixpt serves as a harness for the call to the legacy C function via the generated S-
function.
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open_system('rtwdemo_lct_fixpt_params')
open_system('rtwdemo_lct_fixpt_params/TestFixpt')
sim('rtwdemo_lct_fixpt_params')

See Also
legacy_code

Related Examples
• “Integrate C Functions Using Legacy Code Tool”
• “Call External C Code from Model and Generated Code” on page 51-47
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Integrate External C Functions That Implement N-Dimensional
Table Lookups

Integrate legacy C functions that implement N-dimensional table lookups by using the Legacy Code
Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code

for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You
can initialize the data structure by calling the function legacy_code() using 'initialize' as the first
input. After initializing the structure, assign its properties to values corresponding to the legacy code
being integrated. The prototype of the legacy functions being called in this example is:

FLT directLookupTableND(const FLT *tableND, const UINT32 nbDims, const UINT32 *tableDims,
const UINT32 *tableIdx)

FLT is a typedef to float, and UINT32 is a typedef to unsigned int32. The legacy source code is in the
files your_types.h, lookupTable.h, and directLookupTableND.c.

defs = [];
evalin('base','load rtwdemo_lct_data.mat')

% rtwdemo_sfun_dlut3D
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_dlut3D';
def.OutputFcnSpec = 'single y1 = DirectLookupTable3D(single p1[][][], uint32 p2[3], uint32 u1[3])';
def.HeaderFiles   = {'lookupTable.h'};
def.SourceFiles   = {'directLookupTableND.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_dlut4D
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_dlut4D';
def.OutputFcnSpec = 'single y1 = DirectLookupTable4D(single p1[][][][], uint32 p2[4], uint32 u1[4])';
def.HeaderFiles   = {'lookupTable.h'};
def.SourceFiles   = {'directLookupTableND.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs',
call the function legacy_code() again. Set the first input to 'sfcn_cmex_generate'. The S-functions call
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the legacy functions during simulation. The source code for the S-functions is in the files
rtwdemo_sfun_dlut3D.c and rtwdemo_sfun_dlut4D.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with
Simulink®, call the function legacy_code() again. Set the first input to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_dlut3D
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp88c2b065_4d32_40b8_b17a_d441c55f53b5', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\directLookupTableND.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_dlut3D.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp88c2b065_4d32_40b8_b17a_d441c55f53b5\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_dlut3D
### Exit

### Start Compiling rtwdemo_sfun_dlut4D
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpf5f4320d_ca53_49eb_999d_061524c690ea', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\directLookupTableND.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('rtwdemo_sfun_dlut4D.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex19426386', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpf5f4320d_ca53_49eb_999d_061524c690ea\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_dlut4D
### Exit

Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function legacy_code()
again. Set the first input to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how the
generated code for a model calls the legacy code. If you do not generate TLC block files and you try
to generate code for a model that includes the S-functions, code generation fails. The TLC block files
for the S-functions are rtwdemo_sfun_dlut3D.tlc and rtwdemo_sfun_dlut4D.tlc.

legacy_code('sfcn_tlc_generate', defs);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function legacy_code() again. Set the first input
to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the
required source and header files for the S-functions are not in the same folder as the S-functions, and
you want to add these dependencies in the makefile produced during code generation, generate the
rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', defs);

Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the
first input to 'slblock_generate' to generate masked S-function blocks that call the S-functions. The
software places the blocks in a new model. You can copy the blocks to an existing model.
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legacy_code('slblock_generate', defs);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_lut shows integration of the model with the legacy code. The subsystem
TestFixpt serves as a harness for the call to the legacy C function, and the Display blocks compare the
output of the function with the output of the built-in Simulink® lookup blocks. The results are
identical.

open_system('rtwdemo_lct_lut')
open_system('rtwdemo_lct_lut/TestLut1')
sim('rtwdemo_lct_lut')

See Also
legacy_code

Related Examples
• “Integrate C Functions Using Legacy Code Tool”
• “Call External C Code from Model and Generated Code” on page 51-47
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Integrate External C++ Object Methods
Integrate legacy C++ object methods by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C++ MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a block TLC file and optional rtwmakecfg.m file that calls the legacy code during code

generation.

Provide the Legacy Function Specification

Functions provided with the Legacy Code Tool take a specific data structure or array of structures as
the argument. The data structure is initialized by calling the function legacy_code() using 'initialize'
as the first input. After initializing the structure, assign its properties to values corresponding to the
legacy code being integrated. The definition of the legacy C++ class in this example is:

class adder {
  private:
      int int_state;
  public:
      adder();
      int add_one(int increment);
      int get_val();
};

The legacy source code is in the files adder_cpp.h and adder_cpp.cpp.

% rtwdemo_sfun_adder_cpp
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_adder_cpp';
def.StartFcnSpec  = 'createAdder()';
def.OutputFcnSpec = 'int32 y1 = adderOutput(int32 u1)';
def.TerminateFcnSpec = 'deleteAdder()';
def.HeaderFiles   = {'adder_cpp.h'};
def.SourceFiles   = {'adder_cpp.cpp'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
def.Options.language = 'C++';
def.Options.useTlcWithAccel = false;

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def',
call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function
calls the legacy functions during simulation. The source code for the S-function is in the file
rtwdemo_sfun_adder_cpp.cpp.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with
Simulink®, call the function legacy_code() again with the first input set to 'compile'.

 Integrate External C++ Object Methods

13-53



legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_adder_cpp
    mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex06428671', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp80aa2f94_2487_4318_8062_23844b4992e4', 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\adder_cpp.cpp')
Building with 'Microsoft Visual C++ 2019'.
MEX completed successfully.
    mex('rtwdemo_sfun_adder_cpp.cpp', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp0701ff92\ex06428671', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp80aa2f94_2487_4318_8062_23844b4992e4\adder_cpp.obj')
Building with 'Microsoft Visual C++ 2019'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_adder_cpp
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code()
again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file that supports code
generation through Simulink® Coder™. If the TLC block file is not created and you try to generate
code for a model that includes the S-function, code generation fails. The TLC block file for the S-
function is: rtwdemo_sfun_adder_cpp.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again. Set the first input to
'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code generation through
Simulink® Coder™. If the required source and header files for the S-function are not in the same
folder as the S-function, and you want to add these dependencies in the makefile produced during
code generation, generate the rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the
first input to 'slblock_generate' to generate a masked S-function block that is configured to call that
S-function. The software places the block in a new model. You can copy the block to an existing
model.

% legacy_code('slblock_generate', def);

Show the Generated Integration with Legacy Code

The model rtwdemo_lct_cpp shows integration with the legacy code.

open_system('rtwdemo_lct_cpp')
sim('rtwdemo_lct_cpp')
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See Also
legacy_code

Related Examples
• “Integrate C Functions Using Legacy Code Tool”
• “Call External C Code from Model and Generated Code” on page 51-47
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External Code Integration Examples
This topic shows various scenarios of external code integration.

Integrate External C++ Code into a Model Using S-Functions
This example shows you how to integrate C++ code into a model by using S-functions.

Open Example Model

Open the example model rtwdemo_cpp.

open_system('rtwdemo_cpp');

Configure C++ Compiler

1. In the MATLAB Command Window, enter this command:

mex -setup

2. When prompted, select a C++ compiler that is installed on your development computer.

Integrate C++ Code

You can integrate C++ code into a model by using S-functions.

1. Prepare the S-function source.

• Open sfun_cppcount_cpp.cpp
• Open sfun_cppcount_cpp.h

2. Open the Simulink Coder or Embedded Coder app.

3. Configure S-function source files and folders. Open the Model Configuration Parameter dialog box,
navigate to the Code Generation > Custom Code pane, and add the S-function source files and
include folders.
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4. Inline the S-function to eliminate overhead of S-functions in the generated code.

Open sfun_cppcount_cpp.tlc

Configure Model for C++ Code Generation

Set model configuration parameter Language to C++.

Generate and review code.

Generate and reviw the C++ code.

Related Topics

• “Programming Language Considerations”
• “C++ Language Support Limitations”

Insert External C and C++ Code Into Stateflow Charts for Code
Generation
This example shows how to use Stateflow® to integrate external code into a model.

Open Model

model='rtwdemo_sfcustom';
open_system(model);

Integrate Code

1. The example includes the custom header file my_header.c and the custom source file
my_function.c.

%Open files my_header.h and my_function.c
eval('edit my_header.h')
eval('edit my_function.c')

2. On the Model Configuration Parameters dialog box Simulation Target pane, enter the custom
source file and header file. Also enter additional include directories and source files.

In this example, the custom header file my_header.c and source file my_function.c are entered
on the Simulation Target pane.
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%Open Configuration Parameters dialog box
configSet = getActiveConfigSet(model);
openDialog(configSet);

3. To generate code, on the Model Configuration Parameters dialog box Code Generation > Custom
Code pane, enter the same custom source file and header file. Also enter the same additional include
directories and source files.

In this example, the custom header file my_header.c and source file my_function.c are entered
on the Code Generation > Custom Code pane.

Open the Code Generation > Custom Code pane of the Model Configuration Parameters dialog
box.

configSet = getActiveConfigSet(model);
openDialog(configSet);

Generate Code
slbuild('rtwdemo_sfcustom')

### Starting build procedure for: rtwdemo_sfcustom
### Successful completion of build procedure for: rtwdemo_sfcustom

Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
rtwdemo_sfcustom  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.876s

Call C Code from Stateflow

To call custom C code functions from Stateflow, use the same syntax as graphical function calls:
result = my_custom_function(in_args);

To call variables of structure type, use the dot notation: result = my_var.my_field;

See Also

• Include Custom C Code in Simulation Targets for Library Models
• Integrate Custom C++ Code for Simulation

Close Model
rtwdemoclean;
close_system('rtwdemo_sfcustom',0);

Integrate External C Code Into Generated Code By Using Custom Code
Blocks and Model Configuration Parameters
This example shows how to place external code in generated code by using custom code blocks and
model configuration parameters.
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1. Open the model rtwdemo_slcustcode.

open_system('rtwdemo_slcustcode')

2. Open the Simulink Coder or Embedded Coder app.

3. Open the Model Configuration Parameters dialog box and navigate to the Custom Code pane.

4. Examine the settings for model configuration parameters Source file and Initialize function.

• Source file specifies a comment and sets the variable GLOBAL_INT2 to -1.
• Initialize function initializes the variable GLOBAL_INT2 to 1.

5. Close the dialog box.

6. Double-click the Model Source block. Block parameter Top of Model Source specifies that the
code generator declare the variable GLOBAL_INT1 and set it to 0 at the top of the generated file
rtwdemo_slcustcode.c.

7. Open the triggered subsystem Amplifier. The subsystem includes the System Outputs block. The
code generator places code that you specify in that block in the generated code for the nearest parent
atomic subsystem. In this case, the code generator places the external code in the generated code for
the Amplifier subsystem. The external code:

• Declares the pointer variable *intPtr and initializes it with the value of variable GLOBAL_INT1.
• Sets the pointer variable to -1 during execution.
• Resets the pointer variable to 0 before exiting.
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8. Generate code and a code generation report.

9. Examine the code in the generated source file rtwdemo_slcustcode.c. At the top of the file,
after the #include statements, you find the following declaration code. The example specifies the
first declaration with the Source file configuration parameter and the second declaration with the
Model Source block.

int_T GLOBAL_INT2 = -1;

int_T GLOBAL_INT1 = 0;

The Output function for the Amplifier subsystem includes the following code, which shows the
external code integrated with generated code that applies the gain. The example specifies the three
lines of code for the pointer variable with the System Outputs block in the Amplifier subsystem.

int_T *intPtr = &GLOBAL_INT1;

*intPtr = -1;

rtwdemo_slcustcode_Y.Output = rtwdemo_slcustcode_U.Input << 1;

*intPtr = 0;

The following assignment appears in the model initialize entry-point function. The example specifies
this assignment with the Initialize function configuration parameter.

GLOBAL_INT2 = 1;

Integrate External C Code Into Generated Code By Using Custom Code
Blocks and Model Configuration Parameters
This example shows how to place external code in generated code by using custom code blocks and
model configuration parameters.

1. Open the model rtwdemo_slcustcode.

open_system('rtwdemo_slcustcode')
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2. Open the Simulink Coder or Embedded Coder app.

3. Open the Model Configuration Parameters dialog box and navigate to the Custom Code pane.

4. Examine the settings for model configuration parameters Source file and Initialize function.

• Source file specifies a comment and sets the variable GLOBAL_INT2 to -1.
• Initialize function initializes the variable GLOBAL_INT2 to 1.

5. Close the dialog box.

6. Double-click the Model Source block. Block parameter Top of Model Source specifies that the
code generator declare the variable GLOBAL_INT1 and set it to 0 at the top of the generated file
rtwdemo_slcustcode.c.

7. Open the triggered subsystem Amplifier. The subsystem includes the System Outputs block. The
code generator places code that you specify in that block in the generated code for the nearest parent
atomic subsystem. In this case, the code generator places the external code in the generated code for
the Amplifier subsystem. The external code:

• Declares the pointer variable *intPtr and initializes it with the value of variable GLOBAL_INT1.
• Sets the pointer variable to -1 during execution.
• Resets the pointer variable to 0 before exiting.

8. Generate code and a code generation report.

9. Examine the code in the generated source file rtwdemo_slcustcode.c. At the top of the file,
after the #include statements, you find the following declaration code. The example specifies the

 External Code Integration Examples

13-61



first declaration with the Source file configuration parameter and the second declaration with the
Model Source block.

int_T GLOBAL_INT2 = -1;

int_T GLOBAL_INT1 = 0;

The Output function for the Amplifier subsystem includes the following code, which shows the
external code integrated with generated code that applies the gain. The example specifies the three
lines of code for the pointer variable with the System Outputs block in the Amplifier subsystem.

int_T *intPtr = &GLOBAL_INT1;

*intPtr = -1;

rtwdemo_slcustcode_Y.Output = rtwdemo_slcustcode_U.Input << 1;

*intPtr = 0;

The following assignment appears in the model initialize entry-point function. The example specifies
this assignment with the Initialize function configuration parameter.

GLOBAL_INT2 = 1;

Insert External C++ Code Into Stateflow Charts for Code Generation
This example shows how to use Stateflow® to integrate external C++ code into a model.

Open Model

model='rtwdemo_sfcpp';
open_system(model);

To setup a C++ compiler, on the command line, enter mex -setup.

Integrate C++ Code

1. Create C-style wrapper functions or access macros for each method called from the C action
language.

%Open example wrapper functions.
filename=fullfile(matlabroot, 'toolbox', 'rtw', 'rtwdemos', 'custom_cpp_src', 'adder_cpp.cpp');
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eval('edit(filename)');
clear filename;

filename=fullfile(matlabroot, 'toolbox', 'rtw', 'rtwdemos', 'custom_cpp_src', 'adder_cpp.h');
eval('edit(filename)');
clear filename;

2. On the Configuration Parameters dialog box Code Generation > Custom Code pane, enter the S-
Function source files and include directories.

%Open Configuration Parameters dialog box
configSet = getActiveConfigSet(model);
openDialog(configSet);

3. On the Configuration Parameters dialog box Simulation Target > Custom Code pane, enter the
S-Function source files and include directories.

%Open Configuration Parameters dialog box
configSet = getActiveConfigSet(model);
openDialog(configSet);

Generate C++ Code

On the Configuration Parameters dialog box Code Generation pane, set Language to C++. To
generate code, select Build.

%Open Configuration Parameters dialog box
configSet = getActiveConfigSet(model);
openDialog(configSet);
clear model;

See Also

• Language Considerations
• C++ Language Limitations

Close Model

rtwdemoclean;
close_system('rtwdemo_sfcpp',0);
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Generate S-Function from Subsystem
The Generate S-function menu option automates generating an S-function from a subsystem. The
Generate S-function menu option presents parameters used within the subsystem and enables you
to declare selected parameters as tunable.

For creating S-Function blocks from a subsystem, see “Create S-Function Blocks from a Subsystem”
on page 63-42.

For example, consider SourceSubsys. The objective is to automatically extract SourceSubsys from
the model and build an S-Function block from it. The workspace variable K, which is the gain factor of
the Gain block within SourceSubsys, is declared and generated as a tunable variable.

To autogenerate an S-function from SourceSubsys that has tunable parameter K:

1 With the SourceSubsys model open, click the subsystem to select it.
2 Right-click the subsystem and select C/C++ Code > Generate S-Function.
3 In the Generate S-Function window you see variables or data objects that are referenced as

block parameters in the subsystem. You can declare them as tunable.

The upper pane of the window displays these columns:

• Variable Name: Name of the parameter.
• Class: If the parameter is a workspace variable, its data type is displayed. If the parameter is

a data object, its name and class is displayed.
• Tunable: Lets you select tunable parameters. To declare a parameter tunable, select the

check box. In this example, the parameter K is declared tunable.

When you select a parameter in the upper pane, the lower pane shows the blocks that reference
the parameter, and the parent system of each block.
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4 After selecting tunable parameters, click the Build button. The build process initiates code
generation and compilation of the S-function by using the S-function target. The Create New
Model option is automatically enabled.

5 The build process displays status messages in the MATLAB Command Window. When the build is
complete, the tunable parameters window closes and a new untitled model window opens.

6 The model window contains an S-Function block with the same name as the subsystem from
which the block was generated (in this example, SourceSubsys). Optionally, you can save the
generated model containing the generated block.

The generated code for the S-Function block is stored in the current working folder. These files
are written to the top-level folder:

• subsys_sf.c or .cpp, where subsys is the subsystem name (for example,
SourceSubsys_sf.c)

• subsys_sf.h
• subsys_sf.mexext, where mexext is a platform-dependent MEX-file extension (for

example, SourceSubsys_sf.mexw64)

The source code for the S-function is written to the subfolder subsys_sfcn_rtw. The top
level .c or .cpp file is a stub file that contains an include directive that you can use to interface
other C/C++ code to the generated code.
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Note See “Required Files for S-Function Deployment” on page 63-41.

The generated S-Function block has inports and outports whose widths and sample times correspond
to those of the original model.

The following code, from the mdlOutputs routine of the generated S-function code (in
SourceSubsys_sf.c) shows how the tunable variable K is referenced by using calls to the MEX API.
static void mdlOutputs(SimStruct *S, int_T tid)
...

/* Gain: '<S1>/Gain' incorporates:
     *  Sum: '<S1>/Sum'
     */
    rtb_Gain_n[0] = (rtb_Product_p + (*(((const
      real_T**)ssGetInputPortSignalPtrs(S, 2))[0]))) * (*(real_T
      *)(mxGetData(K(S))));
    rtb_Gain_n[1] = (rtb_Product_p + (*(((const
      real_T**)ssGetInputPortSignalPtrs(S, 2))[1]))) * (*(real_T
      *)(mxGetData(K(S))));

In automatic S-function generation, the Use Value for Tunable Parameters option is cleared or at
the command line is set to 'off'.

Note Use a MEX S-function wrapper only in the MATLAB version in which the wrapper is created.

Macro Parameters
Suppose that you apply a storage class such as Define to a Simulink.Parameter object so that the
parameter appears as a macro in the generated code. If you use the parameter object inside a
subsystem from which you generate an ERT S-function, you cannot select the parameter object as a
tunable parameter. Instead, the S-function code generator applies the custom storage class to the
parameter object. This generation of macros in the S-function code enables you to generate S-
functions from subsystems that contain variant elements, such as Variant Subsystem blocks, that you
configure to produce preprocessor conditionals in the generated code. You cannot change the value
of the parameter during simulation of the S-function.

To select the parameter object as a tunable parameter, apply a different storage class or create your
own storage class. Storage classes that treat parameters as macros include Define,
ImportedDefine, CompilerFlag, and storage classes that you create by setting Data
initialization to Macro in the Custom Storage Class Designer. If you use a non-macro storage class,
you cannot use the parameter object as a variant control variable and generate preprocessor
conditionals.

If you apply a storage class that treats the parameter object as an imported macro, before you
generate the ERT S-function, provide the macro definition. For example, suppose that you apply the
storage class ImportedDefine to a Simulink.Parameter object and use the parameter object as a
variant control variable in the subsystem. If you set the custom attribute HeaderFile to 'myHdr.h',
when you generate the S-function, place the custom header file myHdr.h in the current folder. The
generated S-function uses the macro value from your header file instead of the value from the Value
property of the parameter object.

To use a macro that you define through a compiler option, for example by applying the storage class
CompilerFlag, use the model configuration parameter Code Generation > Custom Code >
Additional build information > Defines to specify the compiler option. For more information, see
Code Generation Pane: Custom Code: Additional Build Information: Defines.
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See Also
legacy_code

More About
• “S-Functions and Code Generation” on page 13-2
• “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 13-6
• “Use a Bus Signal with S-Function Builder to Create an S-Function”
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S-Functions That Support Expression Folding
Use expression folding to increase the efficiency of code generated by your own inlined S-Function
blocks, by calling macros provided in the S-Function API.

The S-Function API lets you specify whether a given S-Function block should nominally accept
expressions at a given input port. A block should not always accept expressions. For example, if the
address of the signal at the input is used, expressions should not be accepted at that input, because it
is not possible to take the address of an expression.

The S-Function API also lets you specify whether an expression can represent the computations
associated with a given output port. When you request an expression at a block's input or output port,
the Simulink engine determines whether or not it can honor that request, given the block's context.
For example, the engine might deny a block's request to output an expression if the destination block
does not accept expressions at its input, if the destination block has an update function, or if multiple
output destinations exist.

The decision to honor or deny a request to output an expression can also depend on the category of
output expression the block uses.

To take advantage of expression folding in your S-functions, you should understand when to request
acceptance and generation of expressions for specific blocks. You do not have to understand the
algorithm by which the Simulink engine chooses to accept or deny these requests. However, if you
want to trace between the model and the generated code, it is helpful to understand some of the
more common situations that lead to denial of a request.

Categories of Output Expressions
When you implement a C MEX S-function, you can specify whether the code corresponding to a
block's output is to be generated as an expression. If the block generates an expression, you must
specify that the expression is constant, trivial, or generic.

A constant output expression is a direct access to one of the block's parameters. For example, the
output of a Constant block is defined as a constant expression because the output expression is
simply a direct access to the block's Value parameter.

A trivial output expression is an expression that can be repeated, without a performance penalty,
when the output port has multiple output destinations. For example, the output of a Unit Delay block
is defined as a trivial expression because the output expression is simply a direct access to the block's
state. Because the output expression does not have computations, it can be repeated more than once
without degrading the performance of the generated code.

A generic output expression is an expression that should be assumed to have a performance penalty if
repeated. As such, a generic output expression is not suitable for repeating when the output port has
multiple output destinations. For instance, the output of a Sum block is a generic rather than a trivial
expression because it is costly to recompute a Sum block output expression as an input to multiple
blocks.

Examples of Trivial and Generic Output Expressions

Consider this block diagram. The Delay block has multiple destinations, yet its output is designated
as a trivial output expression, so that it can be used more than once without degrading the efficiency
of the code.
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This code excerpt shows the code generated from the Unit Delay block in this block diagram. The
three root outputs are directly assigned from the state of the Unit Delay block, which is stored in a
field of the global data structure rtDWork. Since the assignment is direct, without expressions, there
is no performance penalty associated with using the trivial expression for multiple destinations.
void MdlOutputs(int_T tid)
{
   ...
  /* Outport: <Root>/Out1 incorporates:

   *   UnitDelay: <Root>/Unit Delay */
  rtY.Out1 = rtDWork.Unit_Delay_DSTATE;

  /* Outport: <Root>/Out2 incorporates:
   *   UnitDelay: <Root>/Unit Delay */
  rtY.Out2 = rtDWork.Unit_Delay_DSTATE;

  /* Outport: <Root>/Out3 incorporates:
   *   UnitDelay: <Root>/Unit Delay */
  rtY.Out3 = rtDWork.Unit_Delay_DSTATE;

   ...
}

The code generated shows how code is generated for Sum blocks with single and multiple
destinations.

On the other hand, consider the Sum blocks in this model:

The upper Sum block in the model generates the signal labeled non_triv. Computation of this
output signal involves two multiplications and an addition. If the Sum block's output were permitted
to generate an expression even when the block had multiple destinations, the block's operations
would be duplicated in the generated code. In this case, the generated expressions would proliferate
to four multiplications and two additions. This would degrade the efficiency of the program.
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Accordingly the output of the Sum block is not allowed to be an expression because it has multiple
destinations.

The Simulink engine does not permit the output of the upper Sum block to be an expression because
the signal non_triv is routed to two output destinations. Instead, the result of the multiplication and
addition operations is stored in a temporary variable (rtb_non_triv) that is referenced twice in
the statements that follow, as seen in the code excerpt below.

In contrast, the lower Sum block, which has only a single output destination (Out2), does generate an
expression.

void MdlOutputs(int_T tid)
{
  /* local block i/o variables */
  real_T rtb_non_triv;
  real_T rtb_Sine_Wave;

  /* Sum: <Root>/Sum incorporates:
   *   Gain: <Root>/Gain
   *   Inport: <Root>/u1
   *   Gain: <Root>/Gain1
   *   Inport: <Root>/u2
   *
   * Regarding <Root>/Gain:
   *   Gain value: rtP.Gain_Gain
   *
   * Regarding <Root>/Gain1:
   *   Gain value: rtP.Gain1_Gain
   */
  rtb_non_triv = (rtP.Gain_Gain * rtU.u1) + (rtP.Gain1_Gain * 
rtU.u2);

  /* Outport: <Root>/Out1 */
  rtY.Out1 = rtb_non_triv;

  /* Sin Block: <Root>/Sine Wave */

  rtb_Sine_Wave = rtP.Sine_Wave_Amp *
    sin(rtP.Sine_Wave_Freq * rtmGetT(rtM_model) + 
    rtP.Sine_Wave_Phase) + rtP.Sine_Wave_Bias;

  /* Outport: <Root>/Out2 incorporates:
   *   Sum: <Root>/Sum1
   */
  rtY.Out2 = (rtb_non_triv + rtb_Sine_Wave);
}

Specify the Category of an Output Expression

The S-Function API provides macros that let you declare whether an output of a block should be an
expression, and if so, to specify the category of the expression. This table specifies when to declare a
block output to be a constant, trivial, or generic output expression.

Types of Output Expressions

Category of Expression When to Use
Constant Use only if block output is a direct memory access to a block parameter.
Trivial Use only if block output is an expression that can appear multiple times in

the code without reducing efficiency (for example, a direct memory access
to a field of the DWork vector, or a literal).

Generic Use if output is an expression, but not constant or trivial.
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You must declare outputs as expressions in the mdlSetWorkWidths function using macros defined in
the S-Function API. The macros have the following arguments:

• SimStruct *S: pointer to the block's SimStruct.
• int idx: zero-based index of the output port.
• bool value: pass in TRUE if the port generates output expressions.

The following macros are available for setting an output to be a constant, trivial, or generic
expression:

• void ssSetOutputPortConstOutputExprInRTW(SimStruct *S, int idx, bool value)
• void ssSetOutputPortTrivialOutputExprInRTW(SimStruct *S, int idx, bool

value)
• void ssSetOutputPortOutputExprInRTW(SimStruct *S, int idx, bool value)

The following macros are available for querying the status set by prior calls to the macros above:

• bool ssGetOutputPortConstOutputExprInRTW(SimStruct *S, int idx)
• bool ssGetOutputPortTrivialOutputExprInRTW(SimStruct *S, int idx)
• bool ssGetOutputPortOutputExprInRTW(SimStruct *S, int idx)

The set of generic expressions is a superset of the set of trivial expressions, and the set of trivial
expressions is a superset of the set of constant expressions.

Therefore, when you query an output that has been set to be a constant expression with
ssGetOutputPortTrivialOutputExprInRTW, it returns True. A constant expression is
considered a trivial expression because it is a direct memory access that can be repeated without
degrading the efficiency of the generated code.

Similarly, an output that has been configured to be a constant or trivial expression returns True when
queried for its status as a generic expression.

Acceptance or Denial of Requests for Input Expressions
A block can request that its output be represented in code as an expression. Such a request can be
denied if the destination block cannot accept expressions at its input port. Furthermore, conditions
independent of the requesting block and its destination blocks can prevent acceptance of expressions.

A block should not be configured to accept expressions at its input port under the following
conditions:

• The block must take the address of its input data. It is not possible to take the address of most
types of input expressions.

• The code generated for the block references the input more than once (for example, the Abs or
Max blocks). This would lead to duplication of a potentially complex expression and a subsequent
degradation of code efficiency.
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If a block refuses to accept expressions at an input port, then a block that is connected to that input
port is not permitted to output a generic or trivial expression.

A request to output a constant expression is not denied, because there is no performance penalty for
a constant expression, and the software can take the parameter’s address.

S-Function API to Specify Input Expression Acceptance

The S-Function API provides macros that let you:

• Specify whether a block input should accept nonconstant expressions (that is, trivial or generic
expressions).

• Query whether a block input accepts nonconstant expressions.

By default, block inputs do not accept nonconstant expressions.

You should call the macros in your mdlSetWorkWidths function. The macros have these arguments:

• SimStruct *S: pointer to the block's SimStruct.
• int idx: zero-based index of the input port.
• bool value: pass in TRUE if the port accepts input expressions; otherwise pass in FALSE.

The macro available for specifying whether or not a block input should accept a nonconstant
expression is:

void ssSetInputPortAcceptExprInRTW(SimStruct *S, int portIdx, bool value)

The corresponding macro available for querying the status set by any prior calls to
ssSetInputPortAcceptExprInRTW is:

bool ssGetInputPortAcceptExprInRTW(SimStruct *S, int portIdx)

Denial of Block Requests to Output Expressions

Even after a specific block requests that it be allowed to generate an output expression, that request
can be denied for generic reasons. These reasons include, but are not limited to:

• The output expression is nontrivial, and the output has multiple destinations.
• The output expression is nonconstant, and the output is connected to at least one destination that

does not accept expressions at its input port.
• The output is a test point.
• The output has been assigned an external storage class.
• The output must be stored using global data (for example is an input to a merge block or a block

with states).
• The output signal is complex.

You do not need to consider these generic factors when deciding whether or not to utilize expression
folding for a particular block. However, these rules can be helpful when you are examining generated
code and analyzing cases where the expression folding optimization is suppressed.
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Expression Folding in a TLC Block Implementation
To take advantage of expression folding, modify the TLC block implementation of an inlined S-
Function such that it informs the Simulink engine whether it generates or accepts expressions at its

• Input ports, as explained in “S-Function API to Specify Input Expression Acceptance” on page 13-
72.

• Output ports, as explained in “Categories of Output Expressions” on page 13-68.

This topic discusses required modifications to the TLC implementation.

Expression Folding Compliance

In the BlockInstanceSetup function of your S-function, register your block to be compliant with
expression folding. Otherwise, expression folding requested or allowed at the block's outputs or
inputs will be disabled, and temporary variables will be used.

To register expression folding compliance, call the TLC library function
LibBlockSetIsExpressionCompliant(block), which is defined in
matlabroot/rtw/c/tlc/lib/utillib.tlc. For example:
%% Function: BlockInstanceSetup ===========================================
%%
%function BlockInstanceSetup(block, system) void
  %%
  %<LibBlockSetIsExpressionCompliant(block)>
  %%
%endfunction

You can conditionally disable expression folding at the inputs and outputs of a block by making the
call to this function conditionally.

If you override one of the TLC block implementations provided by the code generator with your own
implementation, you should not make the preceding call until you have updated your implementation.

Output Expressions

The BlockOutputSignal function is used to generate code for a scalar output expression or one
element of a nonscalar output expression. If your block outputs an expression, you should add a
BlockOutputSignal function. The prototype of the BlockOutputSignal is
%function BlockOutputSignal(block,system,portIdx,ucv,lcv,idx,retType) void

The arguments to BlockOutputSignal are these:

• block: the record for the block for which an output expression is being generated
• system: the record for the system containing the block
• portIdx: zero-based index of the output port for which an expression is being generated
• ucv: user control variable defining the output element for which code is being generated
• lcv: loop control variable defining the output element for which code is being generated
• idx: signal index defining the output element for which code is being generated
• retType: character vector defining the type of signal access desired:

"Signal" specifies the contents or address of the output signal

"SignalAddr" specifies the address of the output signal
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The BlockOutputSignal function returns a character vector for the output signal or address. The
character vector should enforce the precedence of the expression by using opening and terminating
parentheses, unless the expression consists of a function call. The address of an expression can only
be returned for a constant expression; it is the address of the parameter whose memory is being
accessed. The code implementing the BlockOutputSignal function for the Constant block is:
%% Function: BlockOutputSignal =================================================
%% Abstract:
%%      Return the reference to the parameter.  This function *may*
%%      be used by Simulink when optimizing the Block IO data structure.
%%
%function BlockOutputSignal(block,system,portIdx,ucv,lcv,idx,retType) void
  %switch retType
    %case "Signal"
      %return LibBlockParameter(Value,ucv,lcv,idx)
    %case "SignalAddr"
      %return LibBlockParameterAddr(Value,ucv,lcv,idx)
    %default
      %assign errTxt = "Unsupported return type: %<retType>"
      %<LibBlockReportError(block,errTxt)>
  %endswitch
%endfunction

The code implementing the BlockOutputSignal function for the Relational Operator block is:
%% Function: BlockOutputSignal =================================================
%% Abstract:
%%      Return an output expression.  This function *may*
%%      be used by Simulink when optimizing the Block IO data structure.
%%
%function BlockOutputSignal(block,system,portIdx,ucv,lcv,idx,retType) void
%switch retType
%case "Signal"
%assign logicOperator = ParamSettings.Operator
 %if ISEQUAL(logicOperator, "~=")
 %assign op = "!="
elseif ISEQUAL(logicOperator, "==") %assign op = "=="
  %else
%assign op = logicOperator
%endif
 %assign u0 = LibBlockInputSignal(0, ucv, lcv, idx)
%assign u1 = LibBlockInputSignal(1, ucv, lcv, idx)
  %return "(%<u0> %<op> %<u1>)"
 %default
 %assign errTxt = "Unsupported return type: %<retType>"
 %<LibBlockReportError(block,errTxt)>
%endswitch
%endfunction

Expression Folding for Blocks with Multiple Outputs

When a block has a single output, the Outputs function in the block's TLC file is called only if the
output port is not an expression. Otherwise, the BlockOutputSignal function is called.

If a block has multiple outputs, the Outputs function is called if any output port is not an expression.
The Outputs function should guard against generating code for output ports that are expressions.
This is achieved by guarding sections of code corresponding to individual output ports with calls to
LibBlockOutputSignalIsExpr().

For example, consider an S-Function with two inputs and two outputs, where

• The first output, y0, is equal to two times the first input.
• The second output, y1, is equal to four times the second input.

The Outputs and BlockOutputSignal functions for the S-function are shown in this code excerpt:
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%% Function: BlockOutputSignal =================================================
%% Abstract:
%%      Return an output expression.  This function *may*
%%      be used by Simulink when optimizing the Block IO data structure.
%%
%function BlockOutputSignal(block,system,portIdx,ucv,lcv,idx,retType) void
%switch retType
%case "Signal"
   %assign u = LibBlockInputSignal(portIdx, ucv, lcv, idx)
 %case "Signal"
 %if portIdx == 0
  %return "(2 * %<u>)"
%elseif portIdx == 1
 %return "(4 * %<u>)"
%endif
%default
%assign errTxt = "Unsupported return type: %<retType>"
 %<LibBlockReportError(block,errTxt)>
%endswitch
%endfunction  
%%
%% Function: Outputs =================================================
%% Abstract:
%%      Compute output signals of block
%%
%function Outputs(block,system) Output
%assign rollVars = ["U", "Y"]
%roll sigIdx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars 
%assign u0 = LibBlockInputSignal(0, "", lcv, sigIdx)
 %assign u1 = LibBlockInputSignal(1, "", lcv, sigIdx)
 %assign y0 = LibBlockOutputSignal(0, "", lcv, sigIdx)
 %assign y1 = LibBlockOutputSignal(1, "", lcv, sigIdx)
%if !LibBlockOutputSignalIsExpr(0)
%<y0> = 2 * %<u0>;
%endif
%if !LibBlockOutputSignalIsExpr(1)
 %<y1> = 4 * %<u1>;
%endif
%endroll
%endfunction

Comments for Blocks That Are Expression-Folding-Compliant

In the past, blocks preceded their outputs code with comments of the form
/* %<Type> Block: %<Name> */

When a block is expression-folding-compliant, the initial line shown above is generated automatically.
Do not include the comment as part of the block's TLC implementation. Register additional
information by using the LibCacheBlockComment function.

The LibCacheBlockComment function takes a character vector as an input, defining the body of the
comment, except for the opening header, the final newline of a single or multiline comment, and the
closing trailer.

The following TLC code illustrates registering a block comment. Note the use of the function
LibBlockParameterForComment, which returns a character vector, suitable for a block comment,
specifying the value of the block parameter.
%openfile commentBuf
  $c(*) Gain value: %<LibBlockParameterForComment(Gain)>
  %closefile commentBuf
  %<LibCacheBlockComment(block, commentBuf)>
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See Also

Related Examples
• “S-Functions That Specify Port Scope and Reusability” on page 13-77
• “S-Functions That Specify Sample Time Inheritance Rules” on page 13-81
• “S-Functions for Code Reuse” on page 13-85
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S-Functions That Specify Port Scope and Reusability
You can use the following SimStruct macros in the mdlInitializeSizes method to specify the
scope and reusability of the memory used for your S-function's input and output ports:

• ssSetInputPortOptimOpts: Specify the scope and reusability of the memory allocated to an S-
function input port.

• ssSetOutputPortOptimOpts: Specify the scope and reusability of the memory allocated to an
S-function output port.

• ssSetInputPortOverWritable: Specify whether one of your S-function's input ports can be
overwritten by one of its output ports.

• ssSetOutputPortOverwritesInputPort: Specify whether an output port can share its
memory buffer with an input port.

You declare an input or output as local or global, and indicate its reusability, by passing one of the
following four options to the ssSetInputPortOptimOpts and ssSetOutputPortOptimOpts
macros:

• SS_NOT_REUSABLE_AND_GLOBAL: Indicates that the input and output ports are stored in separate
memory locations in the global block input and output structure.

• SS_NOT_REUSABLE_AND_LOCAL: Indicates that the code generator can declare individual local
variables for the input and output ports.

• SS_REUSABLE_AND_LOCAL: Indicates that the code generator can reuse a single local variable for
these input and output ports.

• SS_REUSABLE_AND_GLOBAL: Indicates that these input and output ports are stored in a single
element in the global block input and output structure.

Note Marking an input or output port as a local variable does not imply that the code generator uses
a local variable in the generated code. If your S-function accesses the inputs and outputs only in its
mdlOutputs routine, the code generator declares the inputs and outputs as local variables. However,
if the inputs and outputs are used elsewhere in the S-function, the code generator includes them in
the global block input and output structure.

The reusability setting indicates if the memory associated with an input or output port can be
overwritten. To reuse input and output port memory:

1 Indicate the ports are reusable using either the SS_REUSABLE_AND_LOCAL or
SS_REUSABLE_AND_GLOBAL option in the ssSetInputPortOptimOpts and
ssSetOutputPortOptimOpts macros.

2 Indicate the input port memory is overwritable using ssSetInputPortOverWritable.
3 If your S-function has multiple input and output ports, use

ssSetOutputPortOverwritesInputPort to indicate which output and input ports share
memory.

The following example shows how different scope and reusability settings affect the generated code.
The following model contains an S-function block pointing to the C MEX S-function matlabroot/
toolbox/simulink/simdemos/simfeatures/src/sfun_directlook.c, which models a direct
1-D lookup table.
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The S-function's mdlInitializeSizes method declares the input port as reusable, local, and
overwritable and the output port as reusable and local, as follows:
static void mdlInitializeSizes(SimStruct *S)
{
/* snip */
    ssSetInputPortOptimOpts(S, 0, SS_REUSABLE_AND_LOCAL);
    ssSetInputPortOverWritable(S, 0, TRUE);

/* snip */
    ssSetOutputPortOptimOpts(S, 0, SS_REUSABLE_AND_LOCAL);

/* snip */
}

The generated code for this model stores the input and output signals in a single local variable
rtb_SFunction, as shown in the following output function:
static void sl_directlook_output(int_T tid)
{
  /* local block i/o variables */
  real_T rtb_SFunction[2];

  /* Sin: '<Root>/Sine Wave' */
  rtb_SFunction[0] = sin(((real_T)sl_directlook_DWork.counter[0] +
    sl_directlook_P.SineWave_Offset) * 2.0 * 3.1415926535897931E+000 /
    sl_directlook_P.SineWave_NumSamp) * sl_directlook_P.SineWave_Amp[0] +
    sl_directlook_P.SineWave_Bias;
  rtb_SFunction[1] = sin(((real_T)sl_directlook_DWork.counter[1] +
    sl_directlook_P.SineWave_Offset) * 2.0 * 3.1415926535897931E+000 /
    sl_directlook_P.SineWave_NumSamp) * sl_directlook_P.SineWave_Amp[1] +
    sl_directlook_P.SineWave_Bias;

  /* S-Function Block: <Root>/S-Function */
  {
    const real_T *xData = &sl_directlook_P.SFunction_XData[0];
    const real_T *yData = &sl_directlook_P.SFunction_YData [0];
    real_T spacing = xData[1] - xData[0];
    if (rtb_SFunction[0] <= xData[0] ) {
      rtb_SFunction[0] = yData[0];
    } else if (rtb_SFunction[0] >= yData[20] ) {
      rtb_SFunction[0] = yData[20];
    } else {
      int_T idx = (int_T)( ( rtb_SFunction[0] - xData[0] ) / spacing );
      rtb_SFunction[0] = yData[idx];
    }

    if (rtb_SFunction[1] <= xData[0] ) {
      rtb_SFunction[1] = yData[0];
    } else if (rtb_SFunction[1] >= yData[20] ) {
      rtb_SFunction[1] = yData[20];
    } else {
      int_T idx = (int_T)( ( rtb_SFunction[1] - xData[0] ) / spacing );
      rtb_SFunction[1] = yData[idx];
    }
  }

  /* Outport: '<Root>/Out1' */
  sl_directlook_Y.Out1[0] = rtb_SFunction[0];
  sl_directlook_Y.Out1[1] = rtb_SFunction[1];
  UNUSED_PARAMETER(tid);
}
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This table shows variations of the code generated for this model when using the generic real-time
target (GRT). Each row explains a different setting for the scope and reusability of the S-function's
input and output ports.

Scope and
reusability

S-function mdlInitializeSizes code Generated code

Inputs: Local,
reusable,
overwritable

Outputs: Local,
reusable

ssSetInputPortOptimOpts(S, 0,
SS_REUSABLE_AND_LOCAL);

ssSetInputPortOverWritable(S, 0,
TRUE);

ssSetOutputPortOptimOpts(S, 0,
SS_REUSABLE_AND_LOCAL);

The model.c file declares a local variable
in the output function.
/* local block i/o variables */
  real_T rtb_SFunction[2];

Inputs: Global,
reusable,
overwritable

Outputs: Global,
reusable

ssSetInputPortOptimOpts(S, 0,
SS_REUSABLE_AND_GLOBAL);

ssSetInputPortOverWritable(S, 0,
TRUE);

ssSetOutputPortOptimOpts(S, 0,
SS_REUSABLE_AND_GLOBAL);

The model.h file defines a block signals
structure with a single element to store the
S-function's input and output.
/* Block signals (auto storage) */
typedef struct {
  real_T SFunction[2];
} BlockIO_sl_directlook;

The model.c file uses this element of the
structure in calculations of the S-function's
input and output signals.
 /* Sin: '<Root>/Sine Wave' */
sl_directlook_B.SFunction[0] = sin ...
/* snip */
/*S-Function Block:<Root>/S-Function*/
{
const real_T *xData =
  &sl_directlook_P.SFunction_XData[0]

Inputs: Local, not
reusable

Outputs: Local, not
reusable

ssSetInputPortOptimOpts(S, 0,
SS_NOT_REUSABLE_AND_LOCAL);

ssSetInputPortOverWritable(S, 0,
FALSE);

ssSetOutputPortOptimOpts(S, 0,
SS_NOT_REUSABLE_AND_LOCAL);

The model.c file declares local variables
for the S-function's input and output in the
output function
/* local block i/o variables */
  real_T rtb_SineWave[2];
  real_T rtb_SFunction[2];

Inputs: Global, not
reusable

Outputs: Global, not
reusable

ssSetInputPortOptimOpts(S, 0,
SS_NOT_REUSABLE_AND_GLOBAL);

ssSetInputPortOverWritable(S, 0,
FALSE);

ssSetOutputPortOptimOpts(S, 0,
SS_NOT_REUSABLE_AND_GLOBAL);

The model.h file defines a block signal
structure with individual elements to store
the S-function's input and output.
/* Block signals (auto storage) */
typedef struct {
  real_T SineWave[2];
  real_T SFunction[2];
} BlockIO_sl_directlook;

The model.c file uses the different
elements in this structure when calculating
the S-function's input and output.
 /* Sin: '<Root>/Sine Wave' */
sl_directlook_B.SineWave[0] = sin ...
/* snip */
/*S-Function Block:<Root>/S-Function*/
{
const real_T *xData =
  &sl_directlook_P.SFunction_XData[0]
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See Also

Related Examples
• “S-Functions That Support Expression Folding” on page 13-68
• “S-Functions That Specify Sample Time Inheritance Rules” on page 13-81
• “S-Functions for Code Reuse” on page 13-85
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S-Functions That Specify Sample Time Inheritance Rules
For the Simulink engine to determine whether a model can inherit a sample time from a parent
model, the S-functions in the model need to specify how they use sample times. You can specify this
information by calling the macro ssSetModelReferenceSampleTimeInheritanceRule from
mdlInitializeSizes or mdlSetWorkWidths. To use this macro:

1 Check whether the S-function calls any of these macros:

• ssGetSampleTime
• ssGetInputPortSampleTime
• ssGetOutputPortSampleTime
• ssGetInputPortOffsetTime
• ssGetOutputPortOffsetTime
• ssGetInputPortSampleTimeIndex
• ssGetOutputPortSampleTimeIndex

2 Check for these in your S-function TLC code:

• LibBlockSampleTime
• CompiledModel.SampleTime
• LibBlockInputSignalSampleTime
• LibBlockInputSignalOffsetTime
• LibBlockOutputSignalSampleTime
• LibBlockOutputSignalOffsetTime

3 Depending on your search results, use ssSetModelReferenceSampleTimeInheritanceRule
as indicated in this table.

If... Use... Example
None of the macros or
functions are present,
the S-function does not
preclude the model from
inheriting a sample time.

ssSetModelReferenceSampleTimeInheritanceRule
    (S, USE_DEFAULT_FOR_DISCRETE_INHERITANCE)
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If... Use... Example
Any of the macros or
functions are used for:

• Throwing errors if
sample time is
inherited, continuous,
or constant

• Checking
ssIsSampleHit

• Checking whether
sample time is
inherited in either
mdlSetInputPortS
ampleTime or
mdlSetOutputPort
SampleTime before
setting

ssSetModelReferenceSampleTimeInheritanceRule...
(S,USE_DEFAULT_FOR_DISCRETE_INHERITANCE)

Consider this mdlOutputs code:

static void mdlOutputs(SimStruct *S, int_T tid)
{
    const real_T *u = (const real_T*) 
    ssGetInputPortSignal(S,0);
    real_T       *y = ssGetOutputPortSignal(S,0);
    y[0] = ssGetSampleTime(S,tid) * u[0];
}
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If... Use... Example
The S-function uses its
sample time for
computing parameters,
outputs, and so on.

ssSetModelReferenceSampleTimeInheritanceRule
(S, DISALLOW_SAMPLE_TIME_INHERITANCE)

Consider the mdlOutputs code
from the S-function example
sfun_multirate.c:

static void mdlOutputs(SimStruct *S, int_T tid)
{
    InputRealPtrsType enablePtrs;
    int               *enabled = ssGetIWork(S);
    int enableTid = ssGetInputPortSampleTimeIndex(S,ENABLE_IPORT);
    int signalTid = ssGetInputPortSampleTimeIndex(S,SIGNAL_IPORT);
    real_T enableTs       = ssGetInputPortSampleTime(S,ENABLE_IPORT);
    real_T enableTsOffset = ssGetInputPortOffsetTime(S,ENABLE_IPORT);
    if (enableTs == CONTINUOUS_SAMPLE_TIME && enableTsOffset == 0.0) {
        if (ssIsMajorTimeStep(S) && ssIsContinuousTask(S,tid)) {
            if (signalTid == enableTid ||
                ssIsSpecialSampleHit(S, signalTid, enableTid, tid)) {
                enablePtrs = ssGetInputPortRealSignalPtrs(S,ENABLE_IPORT);
                *enabled = (*enablePtrs[0] > 0.0);
            }
        }
    } else {
        int enableTid = ssGetInputPortSampleTimeIndex(S,ENABLE_IPORT);
        if (ssIsSampleHit(S, enableTid, tid)) {
            if (enableTid == signalTid || 
                ssIsSpecialSampleHit(S, signalTid, enableTid, tid)) {
                enablePtrs = ssGetInputPortRealSignalPtrs(S,ENABLE_IPORT);
                *enabled = (*enablePtrs[0] > 0.0);
            }
        }
    }

    if (ssIsSampleHit(S, signalTid, tid) && (*enabled)) {
        InputRealPtrsType uPtrs  = ssGetInputPortRealSignalPtrs(S,SIGNAL_IPORT);
        real_T            signal = *uPtrs[0];
        int               i;
        
        for (i = 0; i < NOUTPUTS; i++) {
            int outTid = ssGetOutputPortSampleTimeIndex(S,i);
            if (outTid==signalTid || 
                ssIsSpecialSampleHit(S, outTid, signalTid, tid)) {
                real_T *y = ssGetOutputPortRealSignal(S,i);
                *y = signal;
            }
        }
    }

} /* end mdlOutputs */

Note If an S-function does not set the ssSetModelReferenceSampleTimeInheritanceRule
macro, by default the Simulink engine assumes that the S-function does not preclude the model
containing that S-function from inheriting a sample time. However, the engine issues a warning
indicating that the model includes S-functions for which this macro is not set.
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You can use settings in the Configuration Parameters on the Diagnostics > Sample Time pane to
control how the Simulink engine responds when it encounters S-functions that have unspecified
sample time inheritance rules. Toggle the Unspecified inheritability of sample time diagnostic to
none, warning, or error. The default is warning.

For information about Model block sample time inheritance, see “Referenced Model Sample Times”.

See Also

Related Examples
• “Specify S-Function Sample Times”
• “S-Functions That Support Expression Folding” on page 13-68
• “S-Functions That Specify Port Scope and Reusability” on page 13-77
• “S-Functions for Code Reuse” on page 13-85
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S-Functions for Code Reuse
You can reuse the generated code for identical subsystems that occur in multiple instances within a
model and across referenced models. For more information about code generation of subsystems for
code reuse, see “Control Generation of Functions for Subsystems”.

S-Function Code Reuse Requirements

To use S-function for code reuse for a subsystem, the S-function must meet these requirements:

• The S-function must be inlined.
• Code generated from the S-function must not use static variables.
• The S-function must initialize its pointer work vector in only mdlStart and not before.
• The S-function must not be a sink that logs data to the workspace.
• The S-function must register its parameters as run-time parameters in mdlSetWorkWidths. For

this purpose, the S-function must not use ssWriteRTWParameters in its mdlRTW function.
• The S-function must not be a device driver.

Additionally, your S-function must set the SS_OPTION_WORKS_WITH_CODE_REUSE flag in the
ssSetOptions function. This flag indicates that your S-function meets the requirements for subsystem
code reuse. If the flag is set and your S-function does not meet the requirements, the code generator
does not generate a reusable function and you see a warning.

S-Functions Reused Across Models

You can place S-functions inside reusable library subsystems. In the S-function file, set both of these
flags:

• SS_OPTION_WORKS_WITH_CODE_REUSE flag in the ssSetOptions function
• ssSetSupportedForCodeReuseAcrossModels set to 1 or true

If you use the legacy_code tool to generate your S-function, the S-function option
supportCodeReuseAcrossModels specifies code reuse across models for the subsystem that
contains the S-function.

Configure the S-function for code reuse across models only if the S-function does not access any
model-specific data structures. This configuration is necessary because the generated code in
_sharedutils folder is compiled separately from the generated code in model_ert_rtw folder.
The reusable library subsystem code generated in the _sharedutils folder does not have access to
types and macros that are declared in model.h. The reusable library subsystem code must be
independent. For more information, see “Generate Reusable Code from Library Subsystems Shared
Across Models”.

If your S-function uses custom functions defined in your external header files, add the
“LibAddtoSystemCustomIncludes(system, incFileName)” function in your S-function's TLC file. For
example, when you add LibAddtoSystemCustomIncludes("company_math.h") in your .tlc
file, the reusable library subsystem code in the _sharedutils folder includes the
#company_math.h header file.

1. Create a new MATLAB working folder. In the MATLAB Command Window, copy these external code
files to your current MATLAB working folder:
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currentDir = pwd;
[~,cgDir] = rtwdemodir();
copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','doubleIt.c'));
copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','doubleIt.h'));

2. Open example model rtwdemo_sfcn_rls. This example model uses two instances of the reusable
library subsystem rtwdemo_sfcn_rls_lib. The S-function sfun_mySrc inside the reusable library
subsystem uses external files doubleIt.c and doubleIt.h.

rtwdemo_sfcn_rls;

3. Generate the S-function code by using legacy code tool. Use these commands in your MATLAB
Command window:

def = legacy_code('initialize');
def.SFunctionName = 'sfun_mySrc';
def.SourceFiles = {'doubleIt.c'};
def.HeaderFiles = {'doubleIt.h'};
def.OutputFcnSpec = 'double y1 = doubleIt(double u1)';

4. Specify the S-function for code reuse:

def.Options.supportCodeReuseAcrossModels = true;

5. Generate the S-function code TLC block file. Then compile the S-function.

legacy_code('sfcn_tlc_generate',def);
legacy_code('sfcn_cmex_generate', def);
legacy_code('compile', def);

### Start Compiling sfun_mySrc
    mex('-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp45867f8d_6950_4b01_abd8_7f455bc86f55\coderdemo', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpdd8c92a7_87b6_4feb_8580_f21402b0418d', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp45867f8d_6950_4b01_abd8_7f455bc86f55\coderdemo\doubleIt.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('sfun_mySrc.c', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp45867f8d_6950_4b01_abd8_7f455bc86f55\coderdemo', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpdd8c92a7_87b6_4feb_8580_f21402b0418d\doubleIt.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling sfun_mySrc
### Exit
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6. The code generator creates the S-function file sfun_mySrc.c and its TLC file sfun_mySrc.tlc
in your MATLAB working folder. In the sfun_mySrc.c file, the code generator adds these
specifications:

file = fullfile('sfun_mySrc.c');
rtwdemodbtype(file,'* All options have the form SS_OPTION_<name>', ...
    'ssSetSupportedForCodeReuseAcrossModels(S, 1);',1,1);

     * All options have the form SS_OPTION_<name> and are documented in
     * matlabroot/simulink/include/simstruc.h. The options should be
     * bitwise or'd together as in
     *    ssSetOptions(S, (SS_OPTION_name1 | SS_OPTION_name2))
     */
    ssSetOptions(S,
        SS_OPTION_USE_TLC_WITH_ACCELERATOR |
        SS_OPTION_CAN_BE_CALLED_CONDITIONALLY |
        SS_OPTION_EXCEPTION_FREE_CODE |
        SS_OPTION_WORKS_WITH_CODE_REUSE |
        SS_OPTION_SFUNCTION_INLINED_FOR_RTW |
        SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME
    );
    ssSetSupportedForCodeReuseAcrossModels(S, 1);

In the sfun_mySrc.c, the SS_OPTION_WORKS_WITH_CODE_REUSE flag is set in the ssSetOptions
function and ssSetSupportedForCodeReuseAcrossModels is set to true.

7. On the Simulink toolstrip, open the Embedded Coder or Simulink Coder app.

8. Generate code for the model. On the C Code tab, click Build.

evalc('slbuild(''rtwdemo_sfcn_rls'')');

The code generator produces a reusable function that can be reused across models in the
_sharedutils folder. Models in a model reference hierarchy share this _sharedutils folder to
reuse code. For this example, the reusable function is generated in the slprj/grt/_sharedutils/
sfunc.c file:

file = fullfile('slprj','grt','_sharedutils','sfunc.c');
rtwdemodbtype(file,'Output and update for atomic system', ...
    'rtb_sfun_mySrc',1,1);

 * Output and update for atomic system:
 *    'ReusableSubsystem' ('rtwdemo_sfcn_rls_lib:60')
 *    'ReusableSubsystem' ('rtwdemo_sfcn_rls_lib:60')
 */
void sfunc(real_T rtu_In1, B_sfunc_T *localB, DW_sfunc_T *localDW)
{
  /* local block i/o variables */
  real_T rtb_sfun_mySrc;

S-Functions Reused Within a Model

By default, S-functions inside a subsystem are not configured for code reuse within a model. You can
specify the S-functions inside a subsystem for code reuse within a model. In the S-function file, set
the SS_OPTION_WORKS_WITH_CODE_REUSE flag in the ssSetOptions function. This flag indicates
that your S-function meets the requirements for subsystem code reuse and is configured for code
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reuse. If the flag is set and your S-function does not meet the requirements, the code generator does
not generate a reusable function and you see a warning.

1. Create a new MATLAB working folder and copy these external code files to your current MATLAB
working folder:

currentDir = pwd;
[~,cgDir] = rtwdemodir();
copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','doubleIt.c'));
copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','doubleIt.h'));

2. For the example model rtwdemo_sfcn_rls, generate the S-function code by using legacy code
tool. Do not include the S-function option supportCodeReuseAcrossModels. Use these commands
in your MATLAB Command window:

def = legacy_code('initialize');
def.SFunctionName = 'sfun_mySrc';
def.SourceFiles = {'doubleIt.c'};
def.HeaderFiles = {'doubleIt.h'};
def.OutputFcnSpec = 'double y1 = doubleIt(double u1)';

3. Generate the S-function code TLC block file. Then compile the S-function.

legacy_code('sfcn_tlc_generate',def);
legacy_code('sfcn_cmex_generate', def);
legacy_code('compile', def);

### Start Compiling sfun_mySrc
    mex('-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpb48347b1_ddc4_45c1_aba0_c91cbdbdb634\coderdemo', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp76f17466_2ddc_4f52_88b6_db9359d45778', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpb48347b1_ddc4_45c1_aba0_c91cbdbdb634\coderdemo\doubleIt.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('sfun_mySrc.c', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tpb48347b1_ddc4_45c1_aba0_c91cbdbdb634\coderdemo', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\14\tp76f17466_2ddc_4f52_88b6_db9359d45778\doubleIt.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling sfun_mySrc
### Exit

4. The code generator creates the S-function file sfun_mySrc.c and its TLC file sfun_mySrc.tlc
in your MATLAB working folder.

file = fullfile('sfun_mySrc.c');
rtwdemodbtype(file,'* All options have the form SS_OPTION_<name>', ...
    'SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME',1,1);

     * All options have the form SS_OPTION_<name> and are documented in
     * matlabroot/simulink/include/simstruc.h. The options should be
     * bitwise or'd together as in
     *    ssSetOptions(S, (SS_OPTION_name1 | SS_OPTION_name2))
     */
    ssSetOptions(S,
        SS_OPTION_USE_TLC_WITH_ACCELERATOR |
        SS_OPTION_CAN_BE_CALLED_CONDITIONALLY |
        SS_OPTION_EXCEPTION_FREE_CODE |
        SS_OPTION_WORKS_WITH_CODE_REUSE |
        SS_OPTION_SFUNCTION_INLINED_FOR_RTW |
        SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME
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In the sfun_mySrc.c file, the code generator adds SS_OPTION_WORKS_WITH_CODE_REUSE flag in
the ssSetOptions function by default but does not include the
ssSetSupportedForCodeReuseAcrossModels specification that prevents the S-function from
being reused across models.

5. On the Simulink toolstrip, open the Embedded Coder or Simulink Coder app.

6. Generate code for the model. On the C Code tab, click Build.

evalc('slbuild(''rtwdemo_sfcn_rls'')');

The code generator produces a reusable function for the subsystem in the rtwdemo_sfcn_rls.c
file, which is outside the _sharedutils folder. This code can be reused within the model but not
across the model reference hierarchy:

file = fullfile('rtwdemo_sfcn_rls_grt_rtw','rtwdemo_sfcn_rls.c');
rtwdemodbtype(file,'void sfunc', ...
    'localDW->UnitDelay_DSTATE = rtb_sfun_mySrc;',1,1);

void sfunc_Init(DW_sfunc_T *localDW)
{
  /* InitializeConditions for UnitDelay: '<S1>/Unit Delay' */
  localDW->UnitDelay_DSTATE = 0.0;
}

/*
 * Output and update for atomic system:
 *    '<Root>/ReusableSubsystem1'
 *    '<Root>/ReusableSubsystem2'
 */
void sfunc(real_T rtu_In1, B_sfunc_T *localB, DW_sfunc_T *localDW)
{
  /* local block i/o variables */
  real_T rtb_sfun_mySrc;

  /* UnitDelay: '<S1>/Unit Delay' */
  localB->UnitDelay = localDW->UnitDelay_DSTATE;

  /* S-Function (sfun_mySrc): '<S1>/sfun_mySrc' */
  rtb_sfun_mySrc = doubleIt(rtu_In1);

  /* Update for UnitDelay: '<S1>/Unit Delay' */
  localDW->UnitDelay_DSTATE = rtb_sfun_mySrc;

See Also

Related Examples
• “S-Functions That Support Expression Folding” on page 13-68
• “S-Functions That Specify Port Scope and Reusability” on page 13-77
• “S-Functions That Specify Sample Time Inheritance Rules” on page 13-81
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S-Functions for Multirate Multitasking Environments
In this section...
“About S-Functions for Multirate Multitasking Environments” on page 13-90
“Rate Grouping Support in S-Functions” on page 13-90
“Create Multitasking, Multirate, Port-Based Sample Time S-Functions” on page 13-90

About S-Functions for Multirate Multitasking Environments
S-functions can be used in models with multiple sample rates and deployed in multitasking target
environments. Likewise, S-functions themselves can have multiple rates at which they operate. The
code generator produces code for multirate multitasking models using an approach called rate
grouping. In code generated for ERT-based targets, rate grouping generates separate model_step
functions for the base rate task and each subrate task in the model. Although rate grouping is a code
generation feature found in ERT targets only, your S-functions can use it in other contexts when you
code them as explained below.

Rate Grouping Support in S-Functions
To take advantage of rate grouping, you must inline your multirate S-functions if you have not done
so. You need to follow certain Target Language Compiler protocols to exploit rate grouping. Coding
TLC to exploit rate grouping does not prevent your inlined S-functions from functioning properly in
GRT. Likewise, your inlined S-functions will still generate valid ERT code even if you do not make
them rate-grouping-compliant. If you do so, however, they will generate more efficient code for
multirate models.

For instructions and examples of Target Language Compiler code illustrating how to create and
upgrade S-functions to generate rate-grouping-compliant code, see “Rate Grouping Compliance and
Compatibility Issues” on page 66-13.

For each multirate S-function that is not rate grouping-compliant, the code generator issues the
following warning when you build:
Warning:  Simulink Coder: Code of output function for multirate block
'<Root>/S-Function' is guarded by sample hit checks rather than being rate
grouped. This will generate the same code for all rates used by the block,
possibly generating dead code. To avoid dead code, you must update the TLC
file for the block.

You will also find a comment such as the following in code generated for each noncompliant S-
function:
/* Because the output function of multirate block
   <Root>/S-Function is not rate grouped,
   the following code might contain unreachable blocks of code.
   To avoid this, you must update your block TLC file. */

The words “update function” are substituted for “output function” in these warnings.

Create Multitasking, Multirate, Port-Based Sample Time S-Functions
The following instructions show how to support both data determinism and data integrity in multirate
S-functions. They do not cover cases where there is no determinism nor integrity. Support for frame-
based processing does not affect the requirements.
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Note The slow rates must be multiples of the fastest rate. The instructions do not apply when two
rates being interfaced are not multiples or when the rates are not periodic.

Rules for Properly Handling Fast-to-Slow Transitions

The rules that multirate S-functions should observe for inputs are

• The input should only be read at the rate that is associated with the input port sample time.
• Generally, the input data is written to DWork, and the DWork can then be accessed at the slower

(downstream) rate.

The input can be read at every sample hit of the input rate and written into DWork memory, but this
DWork memory cannot then be directly accessed by the slower rate. DWork memory that will be read
by the slow rate must only be written by the fast rate when there is a special sample hit. A special
sample hit occurs when both this input port rate and rate to which it is interfacing have a hit.
Depending on their requirements and design, algorithms can process the data in several locations.

The rules that multirate S-functions should observe for outputs are

• The output should not be written by a rate other than the rate assigned to the output port, except
in the optimized case described below.

• The output should always be written when the sample rate of the output port has a hit.

If these conditions are met, the S-Function block can specify that the input port and output port can
both be made local and reusable.

You can include an optimization when little or no processing needs to be done on the data. In such
cases, the input rate code can directly write to the output (instead of by using DWork) when there is a
special sample hit. If you do this, however, you must declare the outport port to be global and not
reusable. This optimization results in one less memcpy but does introduce nonuniform processing
requirements on the faster rate.

Whether you use this optimization or not, the most recent input data, as seen by the slower rate, is
the value when both the faster and slower rate had their hits (and possible earlier input data as well,
depending on the algorithm). Subsequent steps by the faster rate and the associated input data
updates are not seen by the slower rate until the next hit for the slow rate occurs.

Pseudocode Examples of Fast-to-Slow Rate Transition

The pseudocode below abstracts how you should write your C MEX code to handle fast-to-slow
transitions, illustrating with an input rate of 0.1 second driving an output rate of one second. A
similar approach can be taken when inlining the code. The block has following characteristics:

• File: sfun_multirate_zoh.c, Equation: y = u(tslow)
• Input: local and reusable
• Output: local and reusable
• DirectFeedthrough: yes

OutputFcn
if (ssIsSampleHit(".1")) {
    if (ssIsSepcialSampleHit("1")) {
        DWork = u;
    }
}
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if (ssIsSampleHit("1")) {
    y = DWork;
}

An alternative, slightly optimized approach for simple algorithms:

• Input: local and reusable
• Output: global and not reusable because it needs to persist between special sample hits
• DirectFeedthrough: yes

OutputFcn
if (ssIsSampleHit(".1")) {
    if (ssIsSpecialSampleHit("1")) {
        y = u;
    }
}

Example adding a simple algorithm:

• File: sfun_multirate_avg.c; Equation: y = average(u)
• Input: local and reusable
• Output: local and reusable
• DirectFeedthrough: yes

(Assume DWork[0:10] and DWork[mycounter] are initialized to zero)
OutputFcn
if (ssIsSampleHit(".1")) {
    /* In general, processing on 'u' could be done here,
        it runs on every hit of the fast rate. */
    DWork[DWork[mycounter]++] = u;
    if (ssIsSpecialSampleHit("1")) {
    /* In general, processing on DWork[0:10] can be done 
       here, but it does cause the faster rate to have 
       nonuniform processing requirements (every 10th hit, 
       more code needs to be run).*/
        DWork[10] = sum(DWork[0:9])/10;
        DWork[mycounter] = 0;
    }
}
if (ssIsSampleHit("1")) {
    /* Processing on DWork[10] can be done here before
       outputing. This code runs on every hit of the 
       slower task. */
    y = DWork[10];
}

Rules for Properly Handling Slow-to-Fast Transitions

When output rates are faster than input rates, input should only be read at the rate that is associated
with the input port sample time, observing the following rules:

• Always read input from the update function.
• Use no special sample hit checks when reading input.
• Write the input to a DWork.
• When there is a special sample hit between the rates, copy the DWork into a second DWork in the

output function.
• Write the second DWork to the output at every hit of the output sample rate.
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The block can request that the input port be made local but it cannot be set to reusable. The output
port can be set to local and reusable.

As in the fast-to-slow transition case, the input should not be read by a rate other than the one
assigned to the input port. Similarly, the output should not be written to at a rate other than the rate
assigned to the output port.

An optimization can be made when the algorithm being implemented is only required to run at the
slow rate. In such cases, you use only one DWork. The input still writes to the DWork in the update
function. When there is a special sample hit between the rates, the output function copies the same
DWork directly to the output. You must set the output port to be global and not reusable in this case.
This optimization results in one less memcpy operation per special sample hit.

In either case, the data that the fast rate computations operate on is always delayed, that is, the data
is from the previous step of the slow rate code.

Pseudocode Examples of Slow-to-Fast Rate Transition

The pseudocode below abstracts what your S-function needs to do to handle slow-to-fast transitions,
illustrating with an input rate of one second driving an output rate of 0.1 second. The block has
following characteristics:

• File: sfun_multirate_delay.c, Equation: y = u(tslow-1)
• Input: Set to local, will be local if output/update are combined (ERT) otherwise will be global. Set

to not reusable because input needs to be preserved until the update function runs.
• Output: local and reusable
• DirectFeedthrough: no

OutputFcn
if (ssIsSampleHit(".1") {
    if (ssIsSpecialSampleHit("1") {
        DWork[1] = DWork[0];
    }
    y = DWork[1];
}
UpdateFcn
if (ssIsSampleHit("1")) {
    DWork[0] = u;
}

An alternative, optimized approach can be used by some algorithms:

• Input: Set to local, will be local if output/update are combined (ERT) otherwise will be global. Set
to not reusable because input needs to be preserved until the update function runs.

• Output: global and not reusable because it needs to persist between special sample hits.
• DirectFeedthrough: no

OutputFcn
if (ssIsSampleHit(".1") {
    if (ssIsSpecialSampleHit("1") {
        y = DWork;
    }
}
UpdateFcn
if (ssIsSampleHit("1")) {
    DWork = u;
}

Example adding a simple algorithm:
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• File: sfun_multirate_modulate.c, Equation: y = sin(tfast) + u(tslow-1)
• Input: Set to local, will be local if output/update are combined (an ERT feature) otherwise will be

global. Set to not reusable because input needs to be preserved until the update function runs.
• Output: local and reusable
• DirectFeedthrough: no

OutputFcn
if (ssIsSampleHit(".1") {
    if (ssIsSpecialSampleHit("1") {
    /* Processing not likely to be done here. It causes 
     * the faster rate to have nonuniform processing 
     * requirements (every 10th hit, more code needs to 
     * be run).*/
        DWork[1] = DWork[0];
    }
    /* Processing done at fast rate */
    y = sin(ssGetTaskTime(".1")) + DWork[1];
}
UpdateFcn
if (ssIsSampleHit("1")) {
    /* Processing on 'u' can be done here. There is a delay of
       one slow rate period before the fast rate sees it.*/
    DWork[0] = u;}
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Write Noninlined S-Function
A noninlined S-function is a C or C++ MEX S-function that is treated identically by the Simulink
engine and by the generated code. You implement your algorithm once according to the S-function
API. The Simulink engine and generated code call the S-function routines (for example, mdlOutputs)
during model execution.

Noninlined S-functions are identified by the absence of an sfunction.tlc file for your S-function.
The file name varies depending on your platform. For example, on a 64-bit Microsoft® Windows
system, the file name is sfunction.mexw64. In the MATLAB Command Window, type mexext to see
which extension your system uses.

Guidelines for Writing Noninlined S-Functions
• The MEX-file cannot call MATLAB functions.
• If the MEX-file uses functions in the MATLAB External Interface libraries, include the header file

cg_sfun.h instead of mex.h or simulink.c. For the header file cg_sfun.h, at the end of your
S-function, include these lines:
#ifdef MATLAB_MEX_FILE /* Is this file being compiled as a MEX-file? */
#include "simulink.c"  /* MEX-file interface mechanism */
#else
#include "cg_sfun.h"   /* Code generation registration function */
#endif

• Use only the MATLAB API function that the code generator supports. The supported API functions
are:

• mxGetEps
• mxGetInf
• mxGetM
• mxGetN
• mxGetNaN
• mxGetPr
• mxGetScalar
• mxGetString
• mxIsEmpty
• mxIsFinite
• mxIsInf

• MEX library calls are not supported in generated code. To use such calls in the MEX-file and not in
the generated code, add the following condition:
#ifdef MATLAB_MEX_FILE
#endif

• Use only full matrices that contain only real data.
• Do not specify a return value for calls to mxGetString. If you do specify a return value, the MEX-
file does not compile. Instead, use the second input argument of the function, which returns a
pointer to a character vector.

• Use the correct #define s-function_name statement. The S-function name that you specify
must match the S-function file name.
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• If possible, use the data types real_T and int_T instead of double and int. The data types
real_T and int_T are more generic and can be used in multiple environments.

• Provide the build process with the names of the modules used to build the S-function. Use a
template make file, the set_param function, or the S-function modules field of the S-Function
block parameters dialog box. For example, suppose that you build your S-function with this
command:
mex sfun_main.c sfun_module1.c sfun_module2.c

You can then use the following call to set_param to include the required modules:
set_param(sfun_block, "SFunctionModules","sfun_module1 sfun_module2")

When you are ready to generate code, force the code generator to rebuild the top model. For more
information, see “Control Regeneration of Top Model Code”.

Noninlined S-Function Parameter Type Limitations
Parameters to noninlined S-functions can be of the following types only:

• Double precision
• Characters in scalars, vectors, or 2-D matrices

For more flexibility in the type of parameters that you can supply to S-functions or the operations in
the S-function, inline your S-function and consider using an mdlRTW S-function routine.

Use of other functions from the MATLAB matrix.h API or other MATLAB APIs, such as mex.h and
mat.h, are not supported. If you call unsupported APIs from an S-function source file, compiler
errors occur. For details on supported MATLAB API functions, see the files
matlabroot/rtw/c/src/rt_matrx.h and matlabroot/rtw/c/src/rt_matrx.c

If you use mxGetPr on an empty matrix, the function does not return NULL. It returns a random
value. Therefore, you must protect calls to mxGetPr by using mxIsEmpty.

See Also

Related Examples
• “Inlined and Noninlined S-Function Code”
• “S-Functions and Code Generation”
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Write Wrapper S-Function and TLC Files
Create S-functions that work seamlessly with the Simulink and code generator products by using the
wrapper concept. You can:

• Interface your algorithms in Simulink models by writing MEX S-function wrappers
(sfunction.mex).

• Direct the code generator to insert your algorithm into the generated code by creating a TLC S-
function wrapper (sfunction.tlc).

MEX S-Function Wrapper
Creating S-functions by using an S-function wrapper enables you to insert C/C++ code algorithms in
Simulink models and the generated code with little or no change to your original C/C++ function. A
MEX S-function wrapper is an S-function that calls code, which resides in another module.

Note Use a MEX S-function wrapper only in the MATLAB version in which you created the wrapper.

Suppose that you have an algorithm (that is, a C function) called my_alg that resides in the file
my_alg.c. You can integrate my_alg into a Simulink model by creating a MEX S-function wrapper
(for example, wrapsfcn.c). A Simulink model can then call my_alg from an S-Function block. The
Simulink S-function contains a set of empty functions that the Simulink engine requires for various
API related purposes. For example, although only mdlOutputs calls my_alg, the engine calls
mdlTerminate, even though this S-function routine performs no action.

You can embed the call to my_alg in the generated code by creating a TLC S-function wrapper (for
example, wrapsfcn.tlc). You can eliminate the empty function calls. You can avoid the overhead of
executing the mdlOutputs function and you can then eliminate the my_alg function.

Wrapper S-functions are useful when you are creating algorithms that are procedural or when you
are integrating legacy code into a Simulink model. If you want to create code that is:

• Interpretive in nature (that is, highly parameterized by operating modes)
• Heavily optimized (that is, no extra tests to decide what mode the code is operating in)

then you must create a fully inlined TLC file for your S-function.

The next figure shows the wrapper S-function concept.
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Using an S-function wrapper to import algorithms into your Simulink model means that the S-
function serves as an interface that calls your C/C++ algorithms from mdlOutputs. You can quickly
integrate large standalone C/C++ programs into your model without having to change the code.

This sample model includes an S-function wrapper.

Two files are associated with the wrapsfcn block: the S-function wrapper and the C/C++ code that
contains the algorithm. The first three statements:

1 Define the name of the S-function (what you enter in the Simulink S-Function block dialog box).

13 Block Authoring and Code Generation for Simulink Coder

13-98



2 Specify that the S-function is using the level 2 format.
3 Provide access to the SimStruct data structure. SimStruct contains pointers to data used

during simulation and code generation and defines macros that store data in and retrieve data
from the SimStruct.

#define S_FUNCTION_NAME wrapsfcn
#define S_FUNCTION_LEVEL 2
#include "simstruc.h"

extern real_T my_alg(real_T u);  /* Declare my_alg as extern */

/*
 * mdlInitializeSizes - initialize the sizes array
 */
static void mdlInitializeSizes(SimStruct *S)
{

    ssSetNumSFcnParams( S, 0); /*number of input arguments*/

    if (!ssSetNumInputPorts(S, 1)) return;
    ssSetInputPortWidth(S, 0, 1);
    ssSetInputPortDirectFeedThrough(S, 0, 1);

    if (!ssSetNumOutputPorts(S,1)) return;
    ssSetOutputPortWidth(S, 0, 1);
    
    ssSetNumSampleTimes( S, 1);
}

/*
 * mdlInitializeSampleTimes - indicate that this S-function runs
 * at the rate of the source (driving block)
 */
static void mdlInitializeSampleTimes(SimStruct *S)
{
    ssSetSampleTime(S, 0, INHERITED_SAMPLE_TIME);
    ssSetOffsetTime(S, 0, 0.0);
} 

/*
 * mdlOutputs - compute the outputs by calling my_alg, which
 * resides in another module, my_alg.c
 */
static void mdlOutputs(SimStruct *S, int_T tid)
{
    InputRealPtrsType uPtrs = ssGetInputPortRealSignalPtrs(S,0);
    real_T            *y    = ssGetOutputPortRealSignal(S,0);
    *y = my_alg(*uPtrs[0]); /* Call my_alg in mdlOutputs */
 }
/*
 * mdlTerminate - called when the simulation is terminated.
 */
static void mdlTerminate(SimStruct *S)
{
}

#ifdef MATLAB_MEX_FILE /* Is this file being compiled as a MEX-file? */
#include "simulink.c" /* MEX-file interface mechanism */
#else
#include "cg_sfun.h" /* Code generation registration function */
#endif

For more information, see “Templates for C S-Functions”.

The S-function routine mdlOutputs contains a function call to my_alg, which is the C function
containing the algorithm that the S-function performs. For my_alg.c, the code is:
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#ifdef MATLAB_MEX_FILE
#include "tmwtypes.h"
#else
#include "rtwtypes.h"
#endif
real_T my_alg(real_T u)
{
return(u * 2.0);
}

For more information, see “Manage Build Process File Dependencies”.

The wrapper S-function wrapsfcn calls my_alg, which computes u * 2.0. To build wrapsfcn.mex,
use this command:
mex wrapsfcn.c my_alg.c

TLC S-Function Wrapper
A TLC S-function wrapper is a TLC file that specifies how the code generator calls your code. For
example, you can inline the call to my_alg in the mdlOutputs section of the generated code. In the
“MEX S-Function Wrapper” example, the call to my_alg is embedded in the mdlOutputs section as:
*y = my_alg(*uPtrs[0]);

When you are creating a TLC S-function wrapper, the goal is to embed the same type of call in the
generated code.

Look at how the code generator executes S-functions that are not inlined. A noninlined S-function is
identified by the absence of the file sfunction.tlc and the existence of sfunction.mex. When
generating code for a noninlined S-function, the code generator produces a call to mdlOutputs
through a function pointer that, in this example, then calls my_alg.

The wrapper example contains one S-function, wrapsfcn.mex. You must compile and link an
additional module, my_alg, with the generated code. At the MATLAB command prompt, enter:
set_param('wrapper/S-Function','SFunctionModules','my_alg')

Code Overhead for Noninlined S-Functions
The code generated when using grt.tlc as the system target file without wrapsfcn.tlc is:
<Generated code comments for wrapper model with noninlined wrapsfcn S-function>

#include <math.h>
#include <string.h>
#include "wrapper.h"
#include "wrapper.prm"

/* Start the model */
void mdlStart(void)
{
  /* (start code not required) */
}

/* Compute block outputs */
void mdlOutputs(int_T tid)
{
  /* Sin Block: <Root>/Sin */
  rtB.Sin = rtP.Sin.Amplitude *
    sin(rtP.Sin.Frequency * ssGetT(rtS) + rtP.Sin.Phase);

  /* Level2 S-Function Block: <Root>/S-Function (wrapsfcn) */
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  {
    /* Noninlined S-functions create a SimStruct object and
     * generate a call to S-function routine mdlOutputs
     */
    SimStruct *rts = ssGetSFunction(rtS, 0);
    sfcnOutputs(rts, tid);
  }

  /* Outport Block: <Root>/Out */
  rtY.Out = rtB.S_Function;
}

/* Perform model update */
void mdlUpdate(int_T tid)
{
  /* (update code not required) */
}

/* Terminate function */
void mdlTerminate(void)
{
  /* Level2 S-Function Block: <Root>/S-Function (wrapsfcn) */
  {
/* Noninlined S-functions require a SimStruct object and
     * the call to S-function routine mdlTerminate
     */
    SimStruct *rts = ssGetSFunction(rtS, 0);
    sfcnTerminate(rts);
  }
}

#include "wrapper.reg"

/* [EOF] wrapper.c */

The wrapper.reg generated file contains the initialization of the SimStruct for the wrapper S-
Function block. There is one child SimStruct for each S-Function block in your model. You can
significantly reduce this overhead by creating a TLC wrapper for the S-function.

Inline a Wrapper S-Function
The generated code makes the call to your S-function, wrapsfcn.c, in mdlOutputs by using this
code:
SimStruct *rts = ssGetSFunction(rtS, 0);
sfcnOutputs(rts, tid);

This call has computational overhead associated with it. The Simulink engine creates a SimStruct
data structure for the S-Function block. The code generator constructs a call through a function
pointer to execute mdlOutputs, then mdlOutputs calls my_alg. By inlining the call to your C/C++
algorithm, my_alg, you can eliminate both the SimStruct and the extra function call, thereby
improving the efficiency and reducing the size of the generated code.

Inlining a wrapper S-function requires an sfunction.tlc file for the S-function. The TLC file must
contain the function call to my_alg. The figure shows the relationships between the algorithm, the
wrapper S-function, and the sfunction.tlc file.
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To inline the call to my_alg, place your function call in an sfunction.tlc file with the same name
as the S-function (in this example, wrapsfcn.tlc). The Target Language Compiler overrides the
default method of placing calls to your S-function in the generated code.

This code is the TLC file wrapsfcn.tlc that inlines wrapsfcn.c:
%% File    : wrapsfcn.tlc
%% Abstract:
%%      Example inlined tlc file for S-function wrapsfcn.c
%%

%implements "wrapsfcn" "C"

%% Function: BlockTypeSetup ====================================================
%% Abstract:
%%      Create function prototype in model.h as:
%%      "extern real_T my_alg(real_T u);" 
%%
%function BlockTypeSetup(block, system) void
  %openfile buffer
    extern real_T my_alg(real_T u); /* This line is placed in wrapper.h */
  %closefile buffer
  %<LibCacheFunctionPrototype(buffer)>
%endfunction %% BlockTypeSetup

%% Function: Outputs ===========================================================
%% Abstract:
%%      y = my_alg( u );
%%
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %assign u = LibBlockInputSignal(0, "", "", 0)
  %assign y = LibBlockOutputSignal(0, "", "", 0)
  %% PROVIDE THE CALLING STATEMENT FOR "algorithm"
  %% The following line is expanded and placed in mdlOutputs within wrapper.c
  %<y> = my_alg(%<u>); 

%endfunction %% Outputs

The first section of this code inlines the wrapsfcn S-Function block and generates the code in C:
%implements "wrapsfcn" "C"

The next task is to inform the code generator that the routine my_alg must be declared as external in
the generated wrapper.h file for any wrapsfcn S-Function blocks in the model. Do this declaration
once for all wrapsfcn S-Function blocks by using the BlockTypeSetup function. In this function,
you direct the Target Language Compiler to create a buffer and cache the my_alg as extern in the
wrapper.h generated header file.
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The final step is the inlining of the call to the function my_alg. The Outputs function inlines the call.
In this function, you access the block input and output and place a direct call to my_alg. The call is
embedded in wrapper.c.

The Inlined Code
The code generated when you inline your wrapper S-function is similar to the default generated code.
The mdlTerminate function does not contain a call to an empty function and the mdlOutputs
function now directly calls my_alg.
void mdlOutputs(int_T tid)
{
  /* Sin Block: <Root>/Sin */
  rtB.Sin = rtP.Sin.Amplitude *
    sin(rtP.Sin.Frequency * ssGetT(rtS) + rtP.Sin.Phase);

  /* S-Function Block: <Root>/S-Function */
  rtB.S_Function = my_alg(rtB.Sin); /* Inlined call to my_alg */

  /* Outport Block: <Root>/Out */
  rtY.Out = rtB.S_Function;
}

wrapper.reg does not create a child SimStruct for the S-function because the generated code is
calling my_alg directly, eliminating over 1 KB of memory usage.

See Also

Related Examples
• “Write Noninlined S-Function”
• “Write Fully Inlined S-Functions”
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Write Fully Inlined S-Functions
A fully inlined S-function builds your algorithm (block) into generated code that you cannot
distinguish from a built-in block. Typically, a fully inlined S-function requires you to implement your
algorithm twice: once for the Simulink model (C/C++ MEX S-function) and once for code generation
(TLC file).

Using the example in “Write Wrapper S-Function and TLC Files”, you can eliminate the call to
my_alg entirely by specifying the explicit code (that is, 2.0 * u) in wrapsfcn.tlc. While this can
improve performance, if you are working with a large amount of C/C++ code, the task can be lengthy.
You also have to maintain your algorithm in two places, the C/C++ S-function itself and the
corresponding TLC file. Consider whether the performance gains might outweigh the disadvantages.
To inline the algorithm used in this example, in the Outputs section of your wrapsfcn.tlc file,
instead of writing:
%<y> = my_alg(%<u>);

Use:
%<y> = 2.0 * %<u>;

This code is the code produced in mdlOutputs:
void mdlOutputs(int_T tid)
{
  /* Sin Block: <Root>/Sin */
  rtB.Sin = rtP.Sin.Amplitude *
    sin(rtP.Sin.Frequency * ssGetT(rtS) + rtP.Sin.Phase);

  /* S-Function Block: <Root>/S-Function */
  rtB.S_Function = 2.0 * rtB.Sin; /* Explicit embedding of algorithm */

  /* Outport Block: <Root>/Out */
  rtY.Out = rtB.S_Function;
}

The Target Language Compiler replaces the call to my_alg with the algorithm itself.

Multiport S-Function
A more advanced multiport inlined S-function example is sfun_multiport.c and
sfun_multiport.tlc. This S-function illustrates how to create a fully inlined TLC file for an S-
function that contains multiple ports.

Guidelines for Writing Inlined S-Functions
• Consider using the block property RTWdata (see “S-Function RTWdata”). This property is a

structure of character vectors that you can associate with a block. The code generator saves the
structure with the model in the model.rtw file and makes the .rtw file more readable. For
example in the MATLAB Command Window, suppose you enter these commands:
mydata.field1 = 'information for field1';
mydata.field2 = 'information for field2';
set_param(sfun_block, 'RTWdata', mydata);

The .rtw file that the code generator produces for the block includes the comments specified in
the structure mydata.
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• Consider using the mdlRTW function to inline your C MEX S-function in the generated code for:

• Renaming tunable parameters in the generated code.
• Introducing non-tunable parameters into a TLC file.

See Also

Related Examples
• “Write Fully Inlined S-Functions with mdlRTW Routine”
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Write Fully Inlined S-Functions with mdlRTW Routine
You can inline more complex S-functions by using the S-function mdlRTW routine. The mdlRTW routine
provides the code generation process with more information about how the S-function is to be inlined
by creating a parameter record of a non-tunable parameter for use with a TLC file. The mdlRTW
routine places information in the model.rtw file. The mdlRTW function is described in the text file
matlabroot/simulink/src/sfuntmpl_doc.c.

To use the mdlRTW function, take steps to create a direct-index lookup S-function. Lookup tables are
collections of ordered data points of a function. Typically, these tables use some interpolation scheme
to approximate values of the associated function between known data points. To incorporate the
example lookup table algorithm into a Simulink model, the first step is to write an S-function that
executes the algorithm in mdlOutputs. To produce the most efficient code, the next step is to create
a corresponding TLC file to eliminate computational overhead and improve the speed of the lookup
computations.

The Simulink product provides support for general-purpose lookup 1-D, 2-D, and n-D algorithms. You
can use these algorithms as they are or create a custom lookup table S-function to fit your
requirements. You can create a 1-D lookup S-function, sfun_directlook.c, and its corresponding
inlined sfun_directlook.tlc file (see “Target Language Compiler” for more details). You can:

• Error check of S-function parameters.
• Cache information for the S-function that does not change during model execution.
• Use the mdlRTW function to customize the code generator to produce the optimal code for a given

set of block parameters.
• Create a TLC file for an S-function that either fully inlines the lookup table code or calls a wrapper

function for the lookup table algorithm.

S-Function RTWdata
RTWdata is a property of blocks, which can be used by the Target Language Compiler when inlining
an S-function. RTWdata is a structure of character vectors that you can attach to a block. RTWdata is
saved with the model and placed in the model.rtw file when you generate code. For example, this
set of MATLAB commands:
mydata.field1 = 'information for field1';
mydata.field2 = 'information for field2';
set_param(gcb,'RTWdata',mydata)
get_param(gcb,'RTWdata')

produces this result:
ans = 
 
    field1: 'information for field1'
    field2: 'information for field2'

The information for the associated S-Function block inside the model.rtw file is:
Block {
  Type                    "S-Function"
  RTWdata {
    field1                  "information for field1"
    field2                  "information for field2"
  }
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Note RTWdata is saved in the model file for S-functions that are not linked to a library. However,
RTWdata is not persistent for S-Function blocks that are linked to a library.

Direct-Index Lookup Table Algorithm
The 1-D lookup table block provided in the Simulink library uses interpolation or extrapolation when
computing outputs. In this example, you create a lookup table that directly indexes the output vector
(y-data vector) based on the current input (x-data) point.

This direct 1-D lookup example computes an approximate solution p(x)to a partially known function
f(x) at x=x0, given data point pairs (x,y) in the form of an x-data vector and a y-data vector. For a
given data pair (for example, the i'th pair), y_i = f(x_i). It is assumed that the x-data values are
monotonically increasing. If x0 is outside the range of the x-data vector, the first or last point is
returned.

The parameters to the S-function are:
XData, YData, XEvenlySpaced

XData and YData are double vectors of equal length representing the values of the unknown
function. XDataEvenlySpaced is a scalar, 0.0 for false and 1.0 for true. If the XData vector is
evenly spaced, XDataEvenlySpaced is 1.0 and more efficient code is generated.

The graph shows how the parameters XData=[1:6]and YData=[1,2,7,4,5,9] are handled. For
example, if the input (x-value) to the S-Function block is 3, the output (y-value) is 7.
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Direct-Index Lookup Table Example
Improve the lookup table by inlining a direct-index S-function with a TLC file. This direct-index
lookup table S-function does not require a TLC file. The example uses a TLC file for the direct-index
lookup table S-function to reduce the code size and increase efficiency of the generated code.

Implementation of the direct-index algorithm with an inlined TLC file requires the S-function main
module, sfun_directlook.c and a corresponding lookup_index.c module. The
lookup_index.c module contains the GetDirectLookupIndex function that is used to locate the
index in the XData for the current x input value when the XData is unevenly spaced. The
GetDirectLookupIndex routine is called from the S-function and the generated code. The example
uses the wrapper concept for sharing C/C++ code between Simulink MEX-files and the generated
code.

If the XData is evenly spaced, then both the S-function main module and the generated code contain
the lookup algorithm to compute the y-value of a given x-value because the algorithm is short.

The inlined TLC file is sfun_directlook.tlc, which is used to either perform a wrapper call or
embed the optimal C/C++ code for the S-function. (See the example in “mdlRTW Usage”).
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Error Handling
In sfun_directlook.tlc, the mdlCheckParameters routine verifies that:

• The new parameter settings are valid.
• XData and YData are vectors of the same length containing real, finite numbers.
• XDataEvenlySpaced is a scalar.
• The XData vector is a monotonically increasing vector and evenly spaced.

The mdlInitializeSizes function explicitly calls mdlCheckParameters after it verifies the
number of parameters passed to the S-function. After the Simulink engine calls
mdlInitializeSizes, it then calls mdlCheckParameters whenever you change the parameters or
reevaluate them.

User Data Caching
In sfun_directlook.tlc, the mdlStart routine shows how to cache information that does not
change during the simulation or while the generated code is executing. The example caches the value
of the XDataEvenlySpaced parameter in UserData, a field of the SimStruct. The following line in
mdlInitializeSizes instructs the Simulink engine to disallow changes to XDataEvenlySpaced.
ssSetSFcnParamTunable(S, iParam, SS_PRM_NOT_TUNABLE);

During execution, mdlOutputs accesses the value of XDataEvenlySpaced from UserData rather
than calling the mxGetPr MATLAB API function.

mdlRTW Usage
The code generator calls the mdlRTW routine while generating the model.rtw file. To produce
optimal code for your Simulink model, you can add information to the model.rtw file about the mode
in which your S-Function block is operating.

The example adds parameter settings to the model.rtw file. The parameter settings do not change
during execution. In this case, the XDataEvenlySpaced S-function parameter cannot change during
execution (ssSetSFcnParamTunable was specified as false (0) for it in mdlInitializeSizes).
The parameter setting (XSpacing) uses the function ssWriteRTWParamSettings.

Because xData and yData are registered as run-time parameters in mdlSetWorkWidths, the code
generator writes to the model.rtw file automatically.

Before examining the S-function and the inlined TLC file, consider the generated code for this model.
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The model uses evenly spaced XData in the top S-Function block and unevenly spaced XData in the
bottom S-Function block. When creating this model, specify the following commands for each S-
Function block.
set_param('sfun_directlook_ex/S-Function','SFunctionModules','lookup_index')
set_param('sfun_directlook_ex/S-Function1','SFunctionModules','lookup_index')

The build process uses the module lookup_index.c when creating the executable.

When generating code for this model, the code generator uses the S-function mdlRTW method to
generate a model.rtw file with the value EvenlySpaced for the XSpacing parameter for the top S-
Function block and the value UnEvenlySpaced for the XSpacing parameter for the bottom S-
Function block. The TLC-file uses the value of XSpacing to determine what algorithm to include in
the generated code. The generated code contains the lookup algorithm when the XData is evenly
spaced, but calls the GetDirectLookupIndex routine when the XData is unevenly spaced. The
generated model.c or model.cpp code for the lookup table example model is similar to this code:
/*
 * sfun_directlook_ex.c
 * 
 * Code generation for Simulink model 
 * "sfun_directlook_ex.slx".
 *
...
 */

#include "sfun_directlook_ex.h"
#include "sfun_directlook_ex_private.h"

/* External outputs (root outports fed by signals with auto storage) */
ExtY_sfun_directlook_ex_T sfun_directlook_ex_Y;

/* Real-time model */
RT_MODEL_sfun_directlook_ex_T sfun_directlook_ex_M_;
RT_MODEL_sfun_directlook_ex_T *const sfun_directlook_ex_M =
  &sfun_directlook_ex_M_;

/* Model output function */
void sfun_directlook_ex_output(void)
{
  /* local block i/o variables */
  real_T rtb_SFunction;
  real_T rtb_SFunction1;

  /* Sin: '<Root>/Sine Wave' */
  rtb_SFunction1 = sin(sfun_directlook_ex_M->Timing.t[0]);
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/* Code that is inlined for the top S-function block in the 
   * sfun_directlook_ex model
   */
  /* S-Function (sfun_directlook): '<Root>/S-Function' */
  {
    const real_T *xData = sfun_directlook_ex_ConstP.SFunction_XData;
    const real_T *yData = sfun_directlook_ex_ConstP.SFunction_YData;
    real_T spacing = xData[1] - xData[0];
    if (rtb_SFunction1 <= xData[0] ) {
      rtb_SFunction = yData[0];
    } else if (rtb_SFunction1 >= yData[20] ) {
      rtb_SFunction = yData[20];
    } else {
      int_T idx = (int_T)( ( rtb_SFunction1 - xData[0] ) / spacing );
      rtb_SFunction = yData[idx];
    }
  }

  /* Outport: '<Root>/Out1' */
  sfun_directlook_ex_Y.Out1 = rtb_SFunction;

/* Code that is inlined for the bottom S-function block in the 
   * sfun_directlook_ex model
   */
  /* S-Function (sfun_directlook): '<Root>/S-Function1' */
  {
    const real_T *xData = sfun_directlook_ex_ConstP.SFunction1_XData;
    const real_T *yData = sfun_directlook_ex_ConstP.SFunction1_YData;
    int_T idx;
    idx = GetDirectLookupIndex(xData, 5, rtb_SFunction1);
    rtb_SFunction1 = yData[idx];
  }

  /* Outport: '<Root>/Out2' */
  sfun_directlook_ex_Y.Out2 = rtb_SFunction1;
}

/* Model update function */
void sfun_directlook_ex_update(void)
{
  /* signal main to stop simulation */
  {                                    /* Sample time: [0.0s, 0.0s] */
    if ((rtmGetTFinal(sfun_directlook_ex_M)!=-1) &&
        !((rtmGetTFinal(sfun_directlook_ex_M)-sfun_directlook_ex_M->Timing.t[0])
          > sfun_directlook_ex_M->Timing.t[0] * (DBL_EPSILON))) {
      rtmSetErrorStatus(sfun_directlook_ex_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
  if (!(++sfun_directlook_ex_M->Timing.clockTick0)) {
    ++sfun_directlook_ex_M->Timing.clockTickH0;
  }

  sfun_directlook_ex_M->Timing.t[0] = sfun_directlook_ex_M->Timing.clockTick0 *
    sfun_directlook_ex_M->Timing.stepSize0 +
    sfun_directlook_ex_M->Timing.clockTickH0 *
    sfun_directlook_ex_M->Timing.stepSize0 * 4294967296.0;
}
...
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See Also

Related Examples
• “Write Fully Inlined S-Functions”
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What is the Target Language Compiler?

• “Target Language Compiler Basics” on page 14-2
• “Why Use the Target Language Compiler?” on page 14-6
• “The Advantages of Inlining S-Functions” on page 14-8
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Target Language Compiler Basics

Target Language Compiler Overview
Target Language Compiler (TLC) is an integral part of the code generator. It enables you to customize
generated code. Through customization, you can produce platform-specific code, or you can
incorporate your own algorithmic changes for performance, code size, or compatibility with existing
methods.

The TLC includes:

• Files corresponding to a subset of the provided Simulink blocks.
• Files for model-wide information that specify header and parameter information.

The TLC files are ASCII files that explicitly control the way that code is generated. By editing a TLC
file, you can alter the way that the code is generated.

The Target Language Compiler provides a complete set of ready-to-use TLC files for generating ANSI
C or C++ code. You can view the TLC files and make minor or extensive changes to them. This open
environment provides tremendous flexibility for customizing the generated code.

For more information, see “Implement C/C++ S-Functions”, which describes how to write wrapped
and fully inlined S-functions, with emphasis on the mdlRTW() function.

Note Do not customize TLC files in the folder matlabroot/rtw/c/tlc, even though the capability
exists. Such TLC customizations might not be applied during the code generation process and can
lead to unpredictable results.

Overview of the TLC Process
This top-level diagram shows how the Target Language Compiler fits in with the code generation
process.
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The Target Language Compiler (TLC) is designed to convert the model description file model.rtw (or
similar files) into target-specific code or text.

The Target Language Compiler transforms a representation of a Simulink block diagram, called
model.rtw, into C or C++ code. The model.rtw file contains a partial representation of the model.
The representation describes the execution semantics of the block diagram in a high-level language.
For more information, see “model.rtw File and Scopes” on page 18-2.

After reading the model.rtw file, the Target Language Compiler generates its code based on target
files, which specify particular code for each block, and model-wide files, which specify the overall
code style. The TLC uses the target files and the model.rtw file to generate ANSI C or C++ code.

To create a target-specific application, the code generator requires a template makefile that specifies
a C or C++ compiler and compiler options for the build process. The code generator transforms the
template makefile into a target makefile (model.mk) by performing token expansion specific to a
given model. The target makefile is a modified version of the generic rt_main file (or grt_main).
You must modify grt_main to conform to the target’s specific requirements, such as interrupt
service routines. See “Template Makefiles and Make Options” and “Customize Template Makefiles”.

The Target Language Compiler has similarities with HTML, Perl, and MATLAB. It has markup syntax
similar to HTML, the power and flexibility of Perl and other scripting languages, and the data
handling power of MATLAB (TLC can invoke MATLAB functions). The code that TLC generated is
highly optimized and fully commented. With TLC, you can generate code from linear, nonlinear,
continuous, discrete, or hybrid Simulink models. The models can include Simulink blocks that are
automatically converted to code. Exceptions are MATLAB function blocks and S-function blocks that
invoke MATLAB files. The Target Language Compiler uses block target files to transform each block
in the model.rtw file and a model-wide target file for global customization of the code.

You can incorporate C MEX S-functions, with the generated code into the program executable. You
can write a target file for your C MEX S-function to inline the S-function (see “Inline C MEX S-
Functions” on page 21-8), to improve performance by eliminating function calls to the S-function
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itself and the memory overhead of theSimStruct of the S-function. Inlining an S-function
incorporates the S-function block code into the generated code for the model. When a TLC target file
is not present for the S-function, it's C or C++ code file is invoked through a function call. See “Inline
S-Functions” on page 21-2. You can also write target files for MATLAB language files or Fortran S-
functions.

Overview of the Code Generation Process
The Target Language Compiler works with its target files and the code generator output to produce
code.

When generating code from a Simulink model, the first step in the automated process is to generate a
model.rtw file. The model.rtw file includes the model-specific information required for generating
code from the Simulink model. model.rtw is passed to the Target Language Compiler, which uses it
in combination with a set of included system target files and block target files to generate the code.

Only the final executable file is written directly to the current folder. For other files created during
code generation, including the model.rtw file, a build folder is used. This folder is created in the
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current folder and is named model_target_rtw. target is the abbreviation for the target
environment grt that is a generic real-time target.

Files placed in the build folder include:

• The body for the generated C or C++ source code (model.c or model.cpp)
• Header files (model.h)
• Header file model_private.h defining parameters and data structures private to the generated

code
• A makefile, model.mk, for building the application
• Additional files, described in “Manage Build Process Files”

See Also

Related Examples
• “Why Use the Target Language Compiler?” on page 14-6
• “Advice About TLC Tutorials” on page 16-2
• “TLC Files” on page 17-11
• “Inline S-Functions with TLC” on page 16-17
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Why Use the Target Language Compiler?
If you simply need to produce ANSI C or C++ code from Simulink models, you do not need to know
how to prepare files for the Target Language Compiler. If you need to customize the output, you must
run the Target Language Compiler. With the Target Language Compiler, you can:

• Customize the set of options specified by your system target file.
• Inline the code for S-Function blocks.
• Generate additional or different types of files.

The MATLAB Function block and the Embedded Coder product facilitate code customization in a
variety of ways. You might be able to accomplish what you need with them, without the need to write
TLC files. However, you do need to prepare TLC files if you intend to inline S-functions.

See the following sections.

Customizing Output
To produce customized output using the Target Language Compiler, it helps if you understand how
blocks perform their functions, what data types are being manipulated, the structure of the
model.rtw file, and how to modify target files to produce the desired output. Directives and Built-In
Functions topics on “Target Language Compiler”, describe the target language directives and their
associated constructs. You will use the Target Language Compiler directives and constructs to modify
existing target files or create new ones, depending on your needs. See “TLC Files” on page 17-11 for
more information about target files.

Note You should not customize TLC files in the folder matlabroot/rtw/c/tlc even though the
capability exists to do so. Such TLC customizations might not be applied during the code generation
process and can lead to unpredictable results.

Inlining S-Functions
The Target Language Compiler provides a great deal of freedom for altering, optimizing, and
enhancing the generated code. One of the most important TLC features is that it lets you inline S-
functions that you write to add your own algorithms, device drivers, and custom blocks to a Simulink
model.

To create an S-function, you write code following a well-defined application program interface (API).
By default, the Target Language Compiler will generate noninlined code for S-functions that invokes
them using this same API. This generalized interface incurs a fair amount of overhead due to the
presence of a large data structure called the SimStruct for each instance of each S-Function block
in your model. In addition, extra run-time overhead is involved whenever methods (functions) within
your S-function are called. You can eliminate this overhead by using the Target Language Compiler to
inline the S-function, by creating a TLC file named sfunction_name.tlc that generates source
code for the S-function as if it were a built-in block. Inlining an S-function improves the efficiency of
the generated code and reduces memory usage.

Defining Advanced Storage Classes
Certain data layouts, such as nested structures, cannot be generated using the standard
Unstructured and FlatStructure storage class types. You can define an advanced storage class if
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you want to generate other types of data. Creating advanced storage classe requires understanding
TLC programming and using a special advanced mode of the Custom Storage Class Designer. For
more information, see “Finely Control Data Representation by Writing TLC Code for a Storage Class”
on page 38-24. Note that this support requires an Embedded Coder license.

See Also

Related Examples
• “Target Language Compiler Process” on page 15-6
• “Code Architecture” on page 15-2
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The Advantages of Inlining S-Functions
The goals of generated code usually include compactness and speed. On the other hand, S-functions
are run-time-loadable extension modules for adding block-level functionality to Simulink. As such, the
S-function interface is optimized for flexibility in configuring and using blocks in a simulation
environment with capability to allow run-time changes to a block’s operation via parameters. These
changes typically take the form of algorithm selection and numerical constants for the block
algorithms.

While switching algorithms is a desirable feature in the design phase of a system, when the time
comes to generate code, this type of flexibility is often dropped in favor of optimal calculation speed
and code size. The Target Language Compiler is designed to allow the generation of code that is
compact and fast by selectively generating only the code you need for one instance of a block’s
parameter set.

When To Avoid Inlining
You might decide not to inline C MEX S-functions that have:

• Few or no numerical parameters.
• One algorithm that is already fixed in capability. For example, it has no optional modes or

alternate algorithms.
• Support for only one data type.
• A significant or large code size in the mdlOutputs() function.
• Multiple instances of S-Function block in your models.

Whenever you encounter this situation, the effort of inlining the block might not improve execution
speed and could actually increase the size of the generated code. The tradeoff is in the size of the
block’s body code generated for each instance versus the size of the child SimStruct created for each
instance of a noninlined S-function in the generated code.

Alternatively, you can use a hybrid inlining method known as a C MEX wrapped S-function, where the
block target file simply generates a call to a custom code function that the S-function itself also calls.
This approach might be the optimal solution for code generation in the case of a large piece of
existing code. See “Write Wrapper S-Function and TLC Files” for the procedure and an example of a
wrapped S-function.

Inlining Process
The strategy for improving code from blocks centers on determining what part of a block’s operations
are active and used in the generated code and what parts can be predetermined or left out.

In practice, this means the TLC code in the block target file will select an algorithm that is a subset of
the algorithms contained in the S-function itself and then selectively hard-code numerical parameters
that are not to be changed at run time. This reduces code memory size and results in code that is
often much faster than its S-function counterpart when mode selection is a significant part of S-
function processing. Additionally, function-call overhead is eliminated for inlined S-functions, as the
code is generated directly in the body of the code unless there is an explicit call to a library function
in the generated code.

The algorithm selections and parameters for each block are output in the initial phase of the code
generation process from the registered S-function parameter set or the mdlRTW() function (if
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present), which results in entries in the model’s .rtw file for that block at code generation time. A
file written in the target language for the block is then called to read the entries in the model.rtw
file and compute the generated code for this instance of the block. This TLC code is contained in the
block target file.

One special case for inlined S-functions is for the case of I/O blocks and drivers such as A/D
converters or communications ports. For simulation, the I/O driver is typically coded in the S-function
as a pure source, a pass-through, or a pure sink. In the generated code, however, an actual interface
to the I/O device must be made, typically through direct coding with the common _in(), _out()
functions, inlined assembly code, or a specific set of I/O library calls unique to the device and target
environment.

Search Algorithm for Locating TLC Files
The Target Language Compiler uses the following search order to locate TLC files:

1 Current folder.
2 Locations specified by %addincludepath directives. The compiler evaluates multiple

%addincludepath directives from the bottom up.
3 Locations specified by -I options. The compiler evaluates multiple -I options from right to left.

For inlined S-function TLC files, the build process supports the following locations:

• The folder where the S-function executable (MEX or MATLAB) file is located.
• S-function folder subfolder ./tlc_c (for C or C++ language targets).
• The current folder when the build process is initiated.

Note Note: Placing the inlined S-function TLC file elsewhere is not supported, even if the location
is in the TLC include path.

The first target file encountered with the required name that implements the specified language is
used in processing the S-function model.rtw file entry.

Note The compiler does not search the MATLAB path, and will not find a file that is available only on
that path. The compiler searches only the locations described above.

Availability for Inlining and Noninlining
S-functions can be written in MATLAB language, Fortran, C, and C++. TLC inlining of S-functions is
available as indicated in this table.
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Inline TLC Support by S-Function Type

S-Function Type Noninlining Supported Inlining Supported
MATLAB language No Yes
Fortran MEX No Yes
C Yes Yes
C++ Yes Yes

See Also

Related Examples
• “Inlining S-Functions” on page 15-8
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Getting Started

• “Code Architecture” on page 15-2
• “Target Language Compiler Process” on page 15-6
• “Inlining S-Functions” on page 15-8
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Code Architecture
Before investigating the specific code generation pieces of the Target Language Compiler (TLC),
consider how Target Language Compiler generates code for a simple model. From the next figure,
you see that blocks place code into Mdl routines. This shows MdlOutputs.

static void simple_output(int_T tid)
{

  /* Sin Block: '<Root>/Sine Wave' */

  simple_B.SineWave_d = simple_P.SineWave_Amp *
    sin(simple_P.SineWave_Freq * simple_M->Timing.t[0] +
    simple_P.SineWave_Phase) + simple_P.SineWave_Bias;

  /* Gain: '<Root>/Gain' */
  simple_B.Gain_d = simple_B.SineWave_d * simple_P.Gain_Gain;

  /* Outport: '<Root>/Out1' */
  simple_Y.Out1 = simple_B.Gain_d;
}

Blocks have inputs, outputs, parameters, states, plus other general properties. For example, block
inputs and outputs are generally written to a block I/O structure (generated with identifiers of the
type model_B, where model is the model name). Block inputs can also come from the external input
structure (model_U) or the state structure when connected to a state port of an integrator
(model_X), or ground (rtGround) if unconnected or grounded. Block outputs can also go to the
external output structure, (model_Y). The following diagram shows the general block data mappings.

This discussion should give you a general sense of what the block object looks like. Now, you can look
at specific pieces of the code generation process that are specific to the Target Language Compiler.
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Code Generation Process
The code generator invokes the Target Language Compiler after a model is compiled into a partial
representation of the model (model.rtw) suitable for code generation. To generate code, the Target
Language Compiler uses its library of functions to transform two classes of target files:

• System target files
• Block target files

System target files are used to specify the overall structure of the generated code, tailoring for
specific target environments. Block target files are used to implement the functionality of Simulink
blocks, including user-defined S-function blocks.

You can create block target files for C MEX, Fortran, and MATLAB language S-functions to fully inline
block functionality into the body of the generated code. C MEX S-functions can be noninlined,
wrapper-inlined, or fully inlined. Fortran S-functions must be wrapper-inlined or fully inlined.

How TLC Determines S-Function Inlining Status
Whenever the Target Language Compiler encounters an entry for an S-function block in the
model.rtw file, it must decide whether to generate a call to the S-function or to inline it.

Because they cannot use SimStructs, Fortran and MATLAB language S-functions must be inlined.
This inlining can either be in the form of a full block target file or a one-line block target file that
refers to a substitute C MEX S-function source file.

The Target Language Compiler selects a C MEX S-function for inlining if an explicit mdlRTW()
function exists in the S-function code or if a target file for the current target language for the current
block is in the TLC file search path. If a C MEX S-function has an explicit mdlRTW() function, there
must be a corresponding target file or an error condition results.

The target file for an S-function must have the same root name as the S-function and must have the
extension .tlc. For example, the target file for a C MEX S-function named sfix_bitop has the
filename sfix_bitop.tlc.

Inlined and Noninlined S-Function Code
This example focuses on a C MEX S-function named sfix_bitop. The code generation options are
set to allow reuse of signal memory for signal lines that were not set as tunable signals.

The code generated for the bit-wise operator block reuses a temporary variable that is set up for the
output of the sum block to save memory. This results in one very efficient line of code, as seen here.
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/* Bitwise Logic Block: <Root>/Bitwise Logical Operator */
/* [input] OR 'F00F' */
rtb_temp2 |= 0xF00F;

Initialization or setup code is not required for this inlined block.

If this block were not inlined, the source code for the S-function itself with its various options would
be added to the generated code base, memory would be allocated in the generated code for the
block’s SimStruct data, and calls to the S-function methods would be generated to initialize, run,
and terminate the S-function code. To execute the mdlOutputs function of the S-function, code
would be generated like this:

/* Level2 S-Function Block: <Root>/Bitwise Logical Operator (sfix_bitop) */
  {
    SimStruct *rts = ssGetSFunction(rtS, 0);
    sfcnOutputs(rts, tid);
  }

The entire mdlOutputs function is called and runs just as it does during simulation. That’s not
everything, though. There is also registration, initialization, and termination code for the noninlined
S-function. The initialization and termination calls are similar to the fragment above. Then, the
registration code for an S-function with just one inport and one outport is 72 lines of C code
generated as part of file model_reg.h.

/*Level2 S-Function Block: <Root>/Bitwise Logical Operator (sfix_bitop) */
    {
      extern void untitled_sf(SimStruct *rts);
      SimStruct *rts = ssGetSFunction(rtS, 0);

      /* timing info */
      static time_T sfcnPeriod[1];
      static time_T sfcnOffset[1];
      static int_T sfcnTsMap[1];

      {
        int_T i;

        for(i = 0; i < 1; i++) {
          sfcnPeriod[i] = sfcnOffset[i] = 0.0;
        }
      }
      ssSetSampleTimePtr(rts, &sfcnPeriod[0]);
      ssSetOffsetTimePtr(rts, &sfcnOffset[0]);
      ssSetSampleTimeTaskIDPtr(rts, sfcnTsMap);
      ssSetMdlInfoPtr(rts, ssGetMdlInfoPtr(rtS));

      /* inputs */
      {
        static struct _ssPortInputs inputPortInfo[1];

        _ssSetNumInputPorts(rts, 1);
        ssSetPortInfoForInputs(rts, &inputPortInfo[0]);

        /* port 0 */
        {

          static real_T const *sfcnUPtrs[1];
          sfcnUPtrs[0] = &rtU.In1;
          ssSetInputPortSignalPtrs(rts, 0, (InputPtrsType)&sfcnUPtrs[0]);
          _ssSetInputPortNumDimensions(rts, 0, 1);
          ssSetInputPortWidth(rts, 0, 1);
        }
      }
.
.
.
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This continues until S-function sizes and methods are declared, allocated, and initialized. The amount
of registration code generated is essentially proportional to the number and size of the input ports
and output ports.

A noninlined S-function will typically have a significant impact on the size of the generated code,
whereas an inlined S-function can be close to the handwritten size and performance of the generated
code.

See Also

Related Examples
• “Write Noninlined S-Function”
• “Write Fully Inlined S-Functions”
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Target Language Compiler Process
To write TLC code for your S-function, you need to understand the Target Language Compiler process
for code generation. As previously described, the Simulink software generates a model.rtw file that
contains a partial representation of the execution semantics of the block diagram. The model.rtw
file is an ASCII file that contains a data structure in the form of a nested set of TLC records. The
records comprise property name/property value pairs. The Target Language Compiler reads the
model.rtw file and converts it into an internal representation.

Next, the Target Language Compiler runs (interprets) the TLC files, starting first with the system
target file, for example, grt.tlc. This is the entry point to the system TLC and block files, that is,
other TLC files included in or generated from the TLC file passed to Target Language Compiler on its
command line (grt.tlc). As the TLC code in the system and block target files is run, it uses,
appends to, and modifies the existing property name/property value pairs and records initially loaded
from the model.rtw file.

model.rtw Structure
The structure of the model.rtw file mirrors the block diagram’s structure:

• For each nonvirtual system in the model, there is a corresponding system record in the
model.rtw file.

• For each nonvirtual block within a nonvirtual system, there is a block record in the model.rtw
file in the corresponding system.

The basic structure of model.rtw is

CompiledModel {
  System {
    Block {
      DataInputPort {
        ...
      }
      DataOutputPort{
        ...
      }
      ParamSettings {
        ...
      }
      Parameter {
        ...
      }
    }
  }
}

Operating Sequence
For each occurrence of a given block in the model, a corresponding block record exists in the
model.rtw file. The system target file TLC code loops through block records and calls the functions
in the corresponding block target file for that block type. For inlined S-functions, it calls the inlining
TLC file.
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There is a method for getting block-specific information (internal block information, as opposed to
inputs, outputs, parameters, etc.) into the block record in the model.rtw file for a block by using the
mdlRTW function in the C MEX function of the block.

Among other things, the mdlRTW function allows you to write out parameter settings
(ParamSettings), that is, unique information pertaining to this block. For parameter settings in the
block TLC file, direct accesses to these fields are made from the block TLC code and can be used to
alter the generated code as desired.

See Also

Related Examples
• “S-Functions and Code Generation”
• “Write Fully Inlined S-Functions with mdlRTW Routine”
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Inlining S-Functions

Inlining an S-function
To inline an S-function means to provide a TLC file for an S-Function block that will replace the C, C+
+, Fortran, or MATLAB language version of the block that was used during simulation.

Noninlined S-Function
If an inlining TLC file is not provided, most targets support the block by recompiling the C MEX S-
function for the block. As discussed earlier, there is overhead in memory usage and speed when using
a C/C++ coded S-function and a limited subset of mx* API calls supported within the code generator
context. If you want the most efficient generated code, you must inline S-functions by writing a TLC
file for them.

When the simulation needs to execute one of the functions for an S-function block, it calls the MEX-
file for that function. When the code generator executes a noninlined S-function, it does so in a
similar manner, as this diagram illustrates.
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Types of Inlining
It is helpful to define two categories of inlining:

• Fully inlined S-functions
• Wrapper inlined S-functions

While both inline the S-function and remove the overhead of a noninlined S-function, the two
approaches are different. The first example below, using timestwo.tlc, is considered a fully inlined
TLC file, where the full implementation of the block is contained in the TLC file for the block.

The second example uses a wrapper TLC file. Instead of generating the algorithmic code in place, this
example calls a C function that contains the body of code. There are several potential benefits for
using the wrapper TLC file:

• It provides a way for the C MEX S-function and the generated code to share the C code. You do
not need to write the code twice.

• The called C function is an optimized routine.
• Several of the blocks might exist in the model, and it is more efficient in terms of code size to have

them call a function, as opposed to each creating identical algorithmic code.
• It provides a way to incorporate legacy C code seamlessly into generated code.

Fully Inlined S-Function Example
Inlining an S-function provides a mechanism to directly embed code for an S-function block into the
generated code for a model. Instead of calling into a separate source file via function pointers and
maintaining a separate data structure (SimStruct) for it, the code appears “inlined” as the next
figure shows.
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The S-function timestwo.c provides a simple example of a fully inlined S-function. This block
multiplies its input by 2 and outputs it. The C MEX version of the block is in the file matlabroot/
toolbox/simulink/simdemos/simfeatures/src/timestwo.c, and the inlining TLC file for the
block is matlabroot/toolbox/simulink/simdemos/simfeatures/tlc_c/timestwo.tlc.

timestwo.tlc
%implements "timestwo" "C"

%% Function: Outputs ==========================================
%%
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %%
  /* Multiply input by two */
  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
    %<LibBlockOutputSignal(0, "", lcv, idx)> = \
    %<LibBlockInputSignal(0, "", lcv, idx)> * 2.0;
  %endroll
%endfunction

TLC Block Analysis

The %implements directive is required by TLC block files and is used by the Target Language
Compiler to verify the block type and language supported by the block. The %function directive
starts a function declaration and shows the name of the function, Outputs, and the arguments
passed to it, block and system. These are the relevant records from the model.rtw file for this
instance of the block.

The last piece of the prototype is Output. This means that any line that is not a TLC directive is
output by the function to the current file that is selected in TLC. So, nondirective lines in the
Outputs function become generated code for the block.
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The most complicated piece of this TLC block example is the %roll directive. TLC uses this directive
to provide automatic generation of for loops, depending on input/output widths and whether the
inputs are contiguous in memory. This example uses the typical form of accessing outputs and inputs
from within the body of the roll, using LibBlockOutputSignal and LibBlockInputSignal to
access the outputs and inputs and perform the multiplication and assignment. Note that this TLC file
supports any valid signal width.

The only function used to implement this block is Outputs. For more complicated blocks, other
functions are declared as well. You can find examples of more complicated inlining TLC files in the
folders matlabroot/toolbox/simulink/simdemos/simfeatures/tlc_c (open) and
matlabroot/toolbox/simulink/blocks/tlc_c (open), and by looking at the code for built-in
blocks in the folder matlabroot/rtw/c/tlc/blocks (open).

The timestwo Model

This simple model uses the timestwo S-function and shows the MdlOutputs function from the
generated model.c file, which contains the inlined S-function code.

Model Outputs Code

/* Model output function */
static void timestwo_ex_output(int_T tid)
{

  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by two */
  timestwo_ex_B.timestwo_output = timestwo_ex_P.Constant_Value 
     * 2.0;

  /* Outport: '<Root>/Out1' */
  timestwo_ex_Y.Out1 = timestwo_ex_B.timestwo_output;
}

Wrapper Inlined S-Function Example
The following diagram illustrates inlining an S-function as a wrapper. The algorithm is directly called
from the generated model code, removing the S-function overhead but maintaining the user function.
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This is the inlining TLC file for a wrapper version of the timestwo block.
%implements "timestwo" "C"

%% Function: BlockTypeSetup ==================================
%%
%function BlockTypeSetup(block, system) void
  %% Add function prototype to model's header file
  %<LibCacheFunctionPrototype...
   ("extern void mytimestwo(real_T* in,real_T* out,int_T els);")>
  %% Add file that contains "myfile" to list of files to be compiled
  %<LibAddToModelSources("myfile")>
%endfunction

%% Function: Outputs ==========================================
%%
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %assign outPtr = LibBlockOutputSignalAddr(0, "", "", 0)
  %assign inPtr = LibBlockInputSignalAddr(0, "", "",0)
  %assign numEls = LibBlockOutputSignalWidth(0)
  /* Multiply input by two */
  mytimestwo(%<inPtr>,%<outPtr>,%<numEls>);
  
%endfunction

Analysis

The function BlockTypeSetup is called once for each type of block in a model; it doesn't produce
output directly like the Outputs function. Use BlockTypeSetup to include a function prototype in
the model.h file and to tell the build process to compile an additional file, myfile.c.

Instead of performing the multiplication directly, the Outputs function now calls the function
mytimestwo. All instances of this block in the model call the same function to perform the
multiplication. The resulting model function, MdlOutputs, then becomes

static void timestwo_ex_output(int_T tid)
{
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  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by two */
  mytimestwo(&model_B.Constant_Value,&model_B.S_Function,1);

  /* Outport Block: <Root>/Out1 */
model_Y.Out1 = model_B.S_Function;
}

See Also

Related Examples
• “Write Noninlined S-Function”
• “Write Wrapper S-Function and TLC Files”
• “Write Fully Inlined S-Functions”
• “Write Fully Inlined S-Functions with mdlRTW Routine”

 Inlining S-Functions
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• “Advice About TLC Tutorials” on page 16-2
• “Read Record Files with TLC” on page 16-4
• “Inline S-Functions with TLC” on page 16-17
• “Explore Variable Names and Loop Rolling” on page 16-21
• “Debug Your TLC Code” on page 16-26
• “TLC Code Coverage to Aid Debugging” on page 16-32
• “Wrap User Code with TLC” on page 16-34
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Advice About TLC Tutorials
The fastest and easiest way to understand the Target Language Compiler (TLC) is to run it, paying
attention to how TLC scripts transform compiled Simulink models (model.rtw files) into source
code. The tutorials highlight the principal reasons for and techniques of using TLC. The tutorials
provide a number of TLC exercises, each one organized as a major section.

The example models, S-functions, and TLC files for the exercises are located in the folder
matlabroot/toolbox/rtw/rtwdemos/tlctutorial (open). In this chapter, this folder is referred
to as tlctutorial. Each example is located in a separate subfolder within tlctutorial. Within
that subfolder, you can find solutions to the problem in a solutions subfolder.

Note Before you begin the tutorial, copy the entire tlctutorial folder to a local working folder.
The files are together, and if you make mistakes or want fresh examples to try again, you can recopy
files from the original tlctutorial folder.

Each tutorial exercise is limited in scope, requiring just a small amount of experimentation. The
tutorial explains details about TLC that will help customize and optimize code for code generation
projects.

Note You should not customize TLC files in the folder matlabroot/rtw/c/tlc even though the
capability exists to do so. Such TLC customizations might not be applied during the code generation
process and can lead to unpredictable results.

The tutorials progress in difficulty from basic to more advanced. To get the most out of them, you
should be familiar with

• Working in the MATLAB environment
• Building Simulink models
• Using the code generator to produce code for target systems
• High-level language concepts (for example, C or Fortran programming)

If you encounter terms in the tutorials that you do not understand, it may be helpful to read “Code
Generation Concepts” on page 17-7 to acquaint yourself with the basic goals and methods of TLC
programming. Similarly, if you see TLC keywords, built-in functions, or directives that you would like
to know more about, see the corresponding topics on “Target Language Compiler”.

The examples used in the tutorial are:

Example Description
guide Illustrative record file
timesN An example C file S-function for multiplying an input by N
tlcdebug An example using TLC Debugger
wrapper Example TLC file for S-function wrapsfcn.c
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See Also

Related Examples
• “Read Record Files with TLC” on page 16-4
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Read Record Files with TLC

Tutorial Overview
Objective: Understand the structure of record files and learn how to parse them with TLC directives.

Folder: matlabroot/toolbox/rtw/rtwdemos/tlctutorial/guide (open)

In this tutorial you interpret a simple file of structured records with a series of TLC scripts. You will
learn how records are structured, and how TLC %assign and %<> token expansion directives are
used to process them. In addition, the tutorial illustrates loops using %foreach, and scoping using
%with.

The tutorial includes these steps, which you should follow sequentially:

1 Structure of Record Files — Some background and a simple example
2 Interpret Records — Presenting contents of the record file
3 Anatomy of a TLC Script — Deconstructing the presentation
4 Modify read-guide.tlc — Experiment with TLC
5 Pass and Use a Parameter— Pass parameters from the command line to TLC files
6 Review

Structure of Record Files
The code generator compiles models into a structured form called a record file, referred to as
model.rtw. Such compiled model files are similar in syntax and organization to source model files, in
that they contain a series of hierarchically nested records of the form

recordName {itemName itemValue}

Item names are alphabetic. Item values can be strings or numbers. Numeric values can be scalars,
vectors, or matrices. Curly braces set off the contents of each record, which may contain one or more
items, delimited by space, tab, or return characters.

In a model.rtw file, the top-level (first) record’s name is CompiledModel. Each block is represented
by a subrecord within it, identified by the block’s name. TLC can parse well-formed record files, as
this exercise illustrates.

The following listing is a valid record file that TLC can parse, although not one for which it can
generate code. Comments are indicated by a pound sign (#):
# 
# File: guide.rtw    Illustrative record file, which can't be used by Simulink
#                                     Note: string values MUST be in quotes
Top {                               # Outermost Record, called Top
  Date         "21-Aug-2008"        # Name/Value pair named Top.Date
  Employee {                        # Nested record within the Top record
    FirstName  "Arthur"             #   Alpha field Top.Employee.FirstName
    LastName   "Dent"               #   Alpha field Top.Employee.LastName
    Overhead    1.78                #   Numeric field Top.Employee.Overhead
    PayRate     11.50               #   Numeric field Top.Employee.PayRate
    GrossRate   0.0                 #   Numeric Field Top.Employee.GrossRate
  }                                 # End of Employee record
  NumProject   3                    # Indicates length of following list
  Project {                         # First list item, called Top.Project[0]
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    Name       "Tea"                #   Alpha field Name, Top.Project[0].Name
    Difficulty 3                    #   Numeric field Top.Project[0].Difficulty
  }                                 # End of first list item
  Project {                         # Second list item, called Top.Project[1]
    Name       "Gillian"            #   Alpha field Name, Top.Project[1].Name
    Difficulty 8                    #   Numeric field Top.Project[1].Difficulty
  }                                 # End of second list item
  Project {                         # Third list item, called Top.Project[2]
    Name       "Zaphod"             #   Alpha field Name, Top.Project[2].Name
    Difficulty 10                   #   Numeric field Top.Project[2].Difficulty
  }                                 # End of third list item
}                                   # End of Top record and of file

As long as programmers know the names of records and fields, and their expected contents, they can
compose TLC statements to read, parse, and manipulate record file data.

Interpret Records
Here is the output from a TLC program script that reads guide.rtw, interprets its records,
manipulates field data, and formats descriptions, which are directed to the MATLAB Command
Window:
Using TLC you can:
* Directly access a field's value, e.g.
  %<Top.Date> -- evaluates to:
  "21-Aug-2008"
  
* Assign contents of a field to a variable, e.g.
  "%assign worker = Top.Employee.FirstName"
  worker expands to Top.Employee.FirstName = "Arthur"

* Concatenate string values, e.g.
  "%assign worker = worker + " " + Top.Employee.LastName"
  worker expands to worker + " " + Top.Employee.LastName = "Arthur Dent"
  
* Perform arithmetic operations, e.g.
  "%assign wageCost = Top.Employee.PayRate * Top.Employee.Overhead"
  wageCost expands to Top.Employee.PayRate * Top.Employee.Overhead <- 11.5 * 1.78 = 20.47
  
* Put variables into a field, e.g.
  Top.Employee.GrossRate starts at 0.0
  "%assign Top.Employee.GrossRate = wageCost"
  Top.Employee.GrossRate expands to wageCost = 20.47

* Index lists of values, e.g.
  "%assign projects = Top.Project[0].Name + ", " + Top.Project[1].Name..."
  "+ ", " + Top.Project[2].Name"
  projects expands to Top.Project[0].Name + ", " + Top.Project[1].Name
  + ", " + Top.Project[2].Name = Tea, Gillian, Zaphod

* Traverse and manipulate list data via loops, e.g.
  - At top of Loop, Project = Tea; Difficulty = 3
  - Bottom of Loop, i = 0; diffSum = 3.0
  - At top of Loop, Project = Gillian; Difficulty = 8
  - Bottom of Loop, i = 1; diffSum = 11.0
  - At top of Loop, Project = Zaphod; Difficulty = 10
  - Bottom of Loop, i = 2; diffSum = 21.0
  Average Project Difficulty expands to diffSum / Top.NumProject = 21.0 / 3 = 7.0

This output from guide.rtw was produced by invoking TLC from the MATLAB Command Window,
executing a script called read-guide.tlc. Do this yourself now, by following these steps:

1 In MATLAB, change folder (cd) to your copy of tlctutorial/guide within your working folder.
2 To produce the output just listed, process guide.rtw with the TLC script read-guide.tlc by

typing the following command:

tlc -v -r guide.rtw read-guide.tlc

Note command usage:
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• The -r switch (for read) identifies the input data file, in this case guide.rtw.
• The TLC script handling the data file is specified by the last token typed.
• The -v switch (for verbose) directs output to the command window, unless the TLC file handles

this itself.

Anatomy of a TLC Script
You now dissect the script you just ran. Each “paragraph” of output from guide.tlc is discussed in
sequence in the following brief sections:

• “Coding Conventions” on page 16-6 — Before you begin
• “File Header” on page 16-6 — Header info and a formatting directive
• “Token Expansion” on page 16-7— Evaluating field and variable identifiers
• “General Assignment” on page 16-7 — Using the %assign directive
• “String Processing Plus” on page 16-8 — Methods of assembling strings
• “Arithmetic Operations” on page 16-9 — Computations on fields and variables
• “Modify Records” on page 16-9 — Changing, copying, appending to records
• “Index Lists” on page 16-10 — Referencing list elements with subscripts
• “Loop Over Lists” on page 16-10 — Details on loop construction and behavior

Coding Conventions

These are some basic TLC syntax and coding conventions:

%% Comment TLC comment, which is not output
/* comment */ Comment, to be output
%keyword TLC directive (keyword), start with “%”
%<expr> TLC token operator
. (period) Scoping operator, for example, Top.Lev2.Lev3
... (at end-of-line) Statement continuation (line break is not output)
\ (at end-of-line) Statement continuation (line break is output)
localvarIdentifier Local variables start in lowercase
GlobalvarIdentifier Global variables start in uppercase
RecordIdentifier Record identifiers start in uppercase
EXISTS() TLC built-in functions are named in uppercase

Note: TLC identifiers are case-sensitive.

For further information, see “TLC Coding Conventions” on page 21-17.

File Header

The file read-guide.tlc begins with:
%% File: read-guide.tlc   (This line is a TLC Comment, and will not print)
%% 
%% To execute this file, type: tlc -v -r guide.rtw read-guide.tlc
%% Set format for displaying real values (default is "EXPONENTIAL")
%realformat "CONCISE"
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• Lines 1 through 4 — Text on a line following the characters %% is treated as a comment (ignored,
not interpreted or output).

• Line 5 — As explained in the text of the fourth line, is the TLC directive (keyword) %realformat,
which controls how subsequent floating-point numbers are formatted when displayed in output.
Here we want to minimize the digits displayed.

Token Expansion

The first section of output is produced by the script lines:

Using TLC you can:
* Directly access a field's value, e.g.
%assign td = "%" + "<Top.Date>"
  %<td> -- evaluates to:
  "%<Top.Date>"

• Lines 1 and 2 — (and lines that contain no TLC directives or tokens) are simply echoed to the
output stream, including leading and trailing spaces.

• Line 3 — Creates a variable named td and assigns the string value %<Top.Date> to it. The
%assign directive creates new and modifies existing variables. Its general syntax is:

%assign ::variable = expression

The optional double colon prefix specifies that the variable being assigned to is a global variable.
In its absence, TLC creates or modifies a local variable in the current scope.

• Line 4 — Displays

%<Top.Date> -- evaluates to:

The preceding line enables TLC to print %<Top.Date> without expanding it. It constructs the
string by pasting together two literals.

%assign td = "%" + "<Top.Date>"

As discussed in “String Processing Plus” on page 16-8, the plus operator concatenates strings
as and adds numbers, vectors, matrices, and records.

• Line 5 — Evaluates (expands) the record Top.Date. More precisely, it evaluates the field Date
which exists in scope Top. The syntax %<expr> causes expression expr (which can be a record, a
variable, or a function) to be evaluated. This operation is sometimes referred to as an eval.

Note You cannot nest the %<expr> operator (that is, %<foo%<bar>> is not allowed).

Note When you use the %<expr> operator within quotation marks, for example, "%<Top.Date>",
TLC expands the expression and then encloses the result in quotation marks. However, placing
%assign within quotation marks, for example, "%assign foo = 3", simply echoes the statement
enclosed in quotation marks to the output stream. No assignment results (the value of foo remains
unchanged or undefined).

General Assignment

The second section of output is produced by the script lines:
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* Assign contents of a field to a variable, e.g.
%assign worker = Top.Employee.FirstName
  "%assign worker = Top.Employee.FirstName"
  worker expands to Top.Employee.FirstName = %<worker>

• Line 1 — Echoed to output.
• Line 2 — An assignment of field FirstName in the Top.Employee record scope to a new local

variable called worker.
• Line 3 — Repeats the previous statement, producing output by enclosing it in quotation marks.
• Line 4 — Explains the following assignment and illustrates the token expansion. The token

%<worker> expands to Arthur.

String Processing Plus

The next section of the script illustrates string concatenation, one of the uses of the “+” operator:

* Concatenate string values, e.g.
%assign worker = worker + " " + Top.Employee.LastName
  "%assign worker = worker + " " + Top.Employee.LastName"
  worker expands to worker + " " + Top.Employee.LastName = "%<worker>"

• Line 1 — Echoed to output.
• Line 2 — Performs the concatenation.
• Line 3 — Echoes line 2 to the output.
• Line 4 — Describes the operation, in which a variable is concatenated to a field separated by a

space character. An alternative way to do this, without using the + operator, is
%assign worker = "%<Top.Employee.FirstName> %<Top.Employee.LastName>"

The alternative method uses evals of fields and is equally efficient.

The + operator, which is associative, also works for numeric types, vectors, matrices, and records:

• Numeric Types — Add two expressions together; both operands must be numeric. For example:

Output:

* Numeric Type example, e.g.
  Top.Employee.PayRate = 11.5
  Top.Employee.Overhead = 1.78
  td = Top.Employee.PayRate + Top.Employee.Overhead
  td evaluates to 13.28

• Vectors — If the first argument is a vector and the second is a scalar value, TLC appends the
scalar value to the vector. For example:

Output:

* Vector example, e.g.
  v1 is [0, 1, 2, 3]
  Top.Project[1].Difficulty is 8
  v2 = v1 + Top.Project[1].Difficulty
  v2 evaluates to: [0, 1, 2, 3, 8]
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• Matrices — If the first argument is a matrix and the second is a vector of the same column-width
as the matrix, TLC appends the vector as another row to the matrix. For example:

Output:

* Matrices example, e.g.
  mx1 is [ [4, 5, 6, 7]; [8, 9, 10, 11] ]
  v1 is [0, 1, 2, 3]
  mx = mx1 + v1
  mx evaluates to [ [4, 5, 6, 7]; [8, 9, 10, 11]; [0, 1, 2, 3] ]

• Records — If the first argument is a record, TLC adds the second argument as a parameter
identifier (with its current value). For example:

Output:

* Record example, e.g.
  StartDate is August 28, 2008 
  Top + StartDate
  Top.StartDate evaluates to August 28, 2008

Arithmetic Operations

TLC provides a full complement of arithmetic operators for numeric data. In the next portion of our
TLC script, two numeric fields are multiplied:
* Perform arithmetic operations, e.g.
%assign wageCost = Top.Employee.PayRate * Top.Employee.Overhead
  "%assign wageCost = Top.Employee.PayRate * Top.Employee.Overhead"
  wageCost expands to Top.Employee.PayRate * Top.Employee.Overhead ...
 <- %<Top.Employee.PayRate> * %<Top.Employee.Overhead> = %<wageCost>

• Line 1 — Echoed to output.
• Line 2 — %assign statement that computes the value, which TLC stores in local variable

wageCost.
• Line 3 — Echoes the operation in line 2.
• Lines 4 and 5 — Compose a single statement. The ellipsis (typed as three consecutive periods, for

example, ... ) signals that a statement is continued on the following line, but if the statement has
output, TLC does not insert a line break. To continue a statement and insert a line break, replace
the ellipsis with a backslash (\).

Modify Records

Once read into memory, you can modify and manipulate records just like variables you create by
assignment. The next segment of read-guide.tlc replaces the value of record field
Top.Employee.GrossRate:
* Put variables into a field, e.g.
%assign Top.Employee.GrossRate = wageCost
  "%assign Top.Employee.GrossRate = wageCost"
  Top.Employee.GrossRate expands to wageCost = %<Top.Employee.GrossRate>

Such changes to records are nonpersistent (because record files are inputs to TLC; other file types,
such as C source code, are outputs), but can be useful.
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You can use several TLC directives besides %assign to modify records:

%createrecord Creates new top-level records, and might also specify subrecords
within them, including name/value pairs.

%addtorecord Adds fields to an existing record. The new fields can be name/value
pairs or aliases to existing records.

%mergerecord Combines one or more records. The first record contains itself plus
copies of the other records' contents specified by the command, in
sequence.

%copyrecord Creates a new record as %createrecord does, except the
components of the record come from the existing record you specify.

%undef var Removes (deletes) var (a variable or a record) from scope. If var is
a field in a record, TLC removes the field from the record. If var is
a record array (list), TLC removes the first element of the array; the
remaining elements remain accessible. You can remove only records
you create with %createrecord or %copyrecord.

See “Target Language Compiler Directives” on page 19-2 for details on these directives.

Index Lists

Record files can contain lists, or sequences of records having the same identifier. Our example
contains a list of three records identified as Project within the Top scope. List references are
indexed, numbered from 0, in the order in which they appear in the record file. Here is TLC code that
compiles data from the Name field of the Project list:
* Index lists of values, e.g.
%assign projects = Top.Project[0].Name + ", " + Top.Project[1].Name...
+ ", " + Top.Project[2].Name
  "%assign projects = Top.Project[0].Name + ", " + Top.Project[1].Name..."
  "+ ", " + Top.Project[2].Name"
  projects expands to Top.Project[0].Name + ", " + Top.Project[1].Name
  + ", " + Top.Project[2].Name = %<projects>

The Scope.Record[n].Field syntax is similar to that used in C to reference elements in an array
of structures.

While explicit indexing, such as the above, is perfectly acceptable, it is often preferable to use a loop
construct when traversing entire lists, as shown in “Loop Over Lists” on page 16-10.

Loop Over Lists

By convention, the section of a record file that a list occupies is preceded by a record that indicates
how many list elements are present. In model.rtw files, such parameters are declared as NumIdent,
where Ident is the identifier used for records in the list that follows. In guide.rtw, the Project
list looks like this:
  NumProject    3                   # Indicates length of following list
  Project {                         # First list item, called Top.Project[0]
    Name       "Tea"                #   Alpha field Name, Top.Project[0].Name
    Difficulty  3                   #   Numeric field Top.Project[0].Difficulty
  }                                 # End of first list item
  Project {                         # Second list item, called Top.Project[1]
    Name       "Gillian"            #   Alpha field Name, Top.Project[1].Name
    Difficulty  8                   #   Numeric field Top.Project[1].Difficulty
  }                                 # End of second list item
  Project {                         # Third list item, called Top.Project[2]
    Name       "Zaphod"             #   Alpha field Name, Top.Project[2].Name
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    Difficulty  10                  #   Numeric field Top.Project[2].Difficulty
  }                                 # End of third list item

Thus, the value of NumProject describes how many Project records occur.

Note model.rtw files might also contain records that start with Num but are not list-size
parameters. TLC does not require that list size parameters start with Num. Therefore you need to be
cautious when interpreting NumIdent record identifiers. The built-in TLC function SIZE() can
determine the number of records in a specified scope, hence the length of a list.

The last segment of read-guide.tlc uses a %foreach loop, controlled by the NumProject
parameter, to iterate the Project list and manipulate its values.
* Traverse and manipulate list data via loops, e.g.
%assign diffSum = 0.0
%foreach i = Top.NumProject
  - At top of Loop, Project = %<Top.Project[i].Name>; Difficulty =...
 %<Top.Project[i].Difficulty>
  %assign diffSum = diffSum + Top.Project[i].Difficulty
  - Bottom of Loop, i = %<i>; diffSum = %<diffSum>
%endforeach
%assign avgDiff = diffSum / Top.NumProject
  Average Project Difficulty expands to diffSum / Top.NumProject = %<diffSum> ...
 / %<Top.NumProject> = %<avgDiff>

As you may recall, the TLC output looks like this:
* Traverse and manipulate list data via loops, e.g.
- At top of Loop, Project = Tea; Difficulty = 3
  - Bottom of Loop, i = 0; diffSum = 3.0
  - At top of Loop, Project = Gillian; Difficulty = 8
  - Bottom of Loop, i = 1; diffSum = 11.0
  - At top of Loop, Project = Zaphod; Difficulty = 10
  - Bottom of Loop, i = 2; diffSum = 21.0
Average Project Difficulty expands to diffSum / Top.NumProjects = 21.0 / 3 = 7.0

After initializing the summation variable diffSum, a %foreach loop is entered, with variable i
declared as the loop counter, iterating up to NumProject. The scope of the loop is all statements
encountered until the corresponding %endforeach is reached (%foreach loops may be nested).

Note Loop iterations implicitly start at zero and range to one less than the index that specifies the
upper bound. The loop index is local to the loop body.

Modify read-guide.tlc
Now that you have studied read-guide.tlc, it is time to modify it. This exercise introduces two
important TLC facilities, file control and scoping control. You implement both within the read-
guide.tlc script.

File Control Basics

TLC scripts almost invariably produce output in the form of streams of characters. Output is normally
directed to one or more buffers and files, collectively called streams. So far, you have directed output
from read-guide.tlc to the MATLAB Command Window because you included the -v switch on the
command line. Prove this by omitting -v when you run read-guide.tlc. Type

tlc -r guide.rtw read-guide.tlc
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Nothing appears to happen. In fact, the script was executed, but output was directed to a null device
(sometimes called the “bit bucket”).

There is one active output file, even if it is null. To specify, open, and close files, use the following TLC
directives:

%openfile streamid ="filename" , "mode"
%closefile streamid
%selectfile streamid

If you do not give a file name, subsequent output flows to the memory buffer named by streamid. If
you do not specify a mode, TLC opens the file for writing and deletes any existing content (subject to
system-level file protection mechanisms). Valid mode identifiers are a (append) and w (write, the
default). Enclose these characters in quotes.

The %openfile directive creates a file/buffer (in w mode), or opens an existing one (in a mode). Note
the required equals sign for file specification. Multiple streams can be open for writing, but only one
can be active at one time. To switch output streams, use the %selectfile directive. You do not need
to close files until you are done with them.

The default output stream, which you can respecify with the stream ID NULL_FILE, is null. Another
built-in stream is STDOUT. When activated using %selectfile, STDOUT directs output to the
MATLAB Command Window.

Note The streams NULL_FILE and STDOUT are always open. Specifying them with %openfile
generates errors. Use %selectfile to activate them.

The directive %closefile closes the current output file or buffer. Until an %openfile or a
%selectfile directive is encountered, output goes to the previously opened stream (or, if none
exists, to null). Use %selectfile to designate an open stream for reading or writing. In practice,
many TLC scripts write pieces of output data to separate buffers, which are then selected in a
sequence and their contents spooled to one or more files.

Implement Output File Control

In your tlctutorial/guide folder, find the file read-guide-file-src.tlc. The supplied version
of this file contains comments and three lines of text added. Edit this file to implement output file
control, as follows:

1 Open read-guide-file-src.tlc in your text editor.
2 Save the file as read-guide-file.tlc.
3 Note five comment lines that begin with %% ->.

Under each of these comments, insert a TLC directive as indicated.
4 Save the edited file as read-guide-file.tlc.
5 Execute read-guide-file.tlc with the following command:

tlc -r guide.rtw read-guide-file.tlc

If you succeeded, TLC creates the file guidetext.txt which contains the expected output, and
the MATLAB Command Window displays
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*** Output being directed to file: guidetext.txt
*** We're almost done . . .
*** Processing completed.

If you did not see these messages, or if a text file was not produced, review the material and try
again. If problems persist, inspect read-guide-file.tlc in the guide/solutions subfolder to
see how you should specify file control.

Scope Basics

“Structure of Record Files” on page 16-4 explains the hierarchical organization of records. Each
record exists within a scope defined by the records in which it is nested. The example file,
guide.rtw, contains the following scopes:

Top
Top.Employee
Top.Project[0]
Top.Project[1]
Top.Project[2]

To refer to a field or a record, specify its scoping, even if no other context that contains the identifier
exists. For example, in guide.rtw, the field FirstName exists only in the scope Top.Employee. You
must refer to it as Top.Employee.FirstName whenever accessing it.

When models present scopes that are deeply nested, this can lead to extremely long identifiers that
are tedious and error prone to type. For example:

CompiledModel.BlockOutputs.BlockOutput.ReusedBlockOutput

This identifier has a scope that is long and has similar item names that you could easily enter
incorrectly.

The %with/%endwith directive eases the burden of coding TLC scripts and clarifies their flow of
control. The syntax is

%with RecordName
  [TLC statements]
%endwith

Every %with is eventually followed by an %endwith, and these pairs might be nested (but not
overlapping). If RecordName is below the top level, you need not include the top-level scope in its
description. For example, to make the current scope of guide.rtw Top.Employee, you can specify

%with Employee
  [TLC statements]
%endwith

Naturally, %with Top.Employee is also valid syntax. Once bracketed by %with/%endwith, record
identifiers in TLC statements do not require you to specify their outer scope. However, note the
following conditions :

• You can access records outside of the current %with scope, but you must qualify them fully (for
example, using record name and fields).

• Whenever you make assignments to records inside a %with directive, you must qualify them fully.
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Change Scope Using %with

In the last segment of this exercise, you modify the TLC script by adding a %with/%endwith
directive. You also need to edit record identifier names (but not those of local variables) to account
for the changes of scope resulting from the %with directives.

1 Open the TLC script read-guide-scope-src.tlc in the text editor.
2 Save the file as read-guide-scope.tlc.
3 Note comment lines that commence with %% ->.

Under each of these comments, insert a TLC directive or modify statements already present, as
indicated.

4 Save the edited file as read-guide-scope.tlc.
5 Execute read-guide-scope.tlc with the following command:

tlc -v -r guide.rtw read-guide-scope.tlc

The output should be exactly the same as from read-guide.tlc, except possibly for white space
that you might have introduced by indenting sections of code inside %with/%endwith or by
eliminating blank lines.

Fully specifying a scope inside a %with context is not an error, it is simply unnecessary. However,
failing to fully specify its scope when assigning it to a record (for example, %assign GrossRate =
wageCost) is invalid.

If errors result from running the script, review the discussion of scoping above and edit read-
guide-scope.tlc to eliminate them. As a last resort, inspect read-guide-scope.tlc in the /
solutions subfolder to see how you should have handled scoping in this exercise.

For additional information, see “Scopes in the model.rtw File” on page 18-2 and “Variable Scoping”
on page 19-38.

Pass and Use a Parameter
You can use the TLC commands and built-in functions to pass parameters from the command line to
the TLC file being executed. The most general command switch is -a, which assigns arbitrary
variables. For example:

tlc -r input.rtw -avar=1 -afoo="abc" vars.tlc

The result of passing this pair of strings via -a is the same as declaring and initializing local variables
in the file being executed (here, vars.tlc). For example:

%assign var = 1
%assign foo = "abc"

You do not need to declare such variables in the TLC file, and they are available for use when set with
-a. However, errors result if the code assigns undeclared variables that you do not specify with the -
a switch when invoking the file. Also note that (in contrast to the -r switch) a space should not
separate -a from the parameter you are declaring.

In the final section of this tutorial, you use the built-in function GET_COMMAND_SWITCH() to print the
name of the record file being used in the TLC script, and provide a parameter to control whether or
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not the code is suppressed. By default the code is executed, but is suppressed if the command line
contains -alist=0:

1 Open the TLC script read-guide-param-src.tlc in your text editor.
2 Save the file as read-guide-param.tlc.
3 To enable your program to access the input filename from the command line, do the following:

a Below the line %selectfile STDOUT, add the line:

%assign inputfile = GET_COMMAND_SWITCH ("r")

The %assign directive declares and sets variables. In this instance, it holds a string filename
identifier. GET_COMMAND_SWITCH() returns whatever string argument follows a specified
TLC command switch. You must use UPPERCASE for built-in function names.

b Change the line “*** WORKING WITH RECORDFILE” to read as follows:

*** WORKING WITH RECORDFILE %<inputfile>
4 To control whether or not a section of TLC code is executed, do the following:

a Below the line “%assign inputfile = GET_COMMAND_SWITCH ("r")”, add:

%if (!EXISTS(list))
    %assign list = 1
%endif

The program checks whether a list parameter has been declared, via the intrinsic (built-in)
function EXISTS(). If no list variable exists, the program assigns one. This defines list and
by default its value is TRUE.

b Enclose lines of code within an %if block.

%if (list)
    * Assign contents of a field to a variable, e.g.
      %assign worker = FirstName
      "%assign worker = FirstName"
      worker expands to FirstName = %<worker>
%endif

Now the code to assign worker is sent to the output only when list is TRUE.
c Save read-guide-param.tlc.

5 Execute read-guide-param.tlc and examine the output, using the command

tlc -r guide.rtw read-guide-param.tlc

This yields

*** WORKING WITH RECORDFILE [guide.rtw]
* Assign contents of a field to a variable, e.g.
      "%assign worker = FirstName"
      worker expands to FirstName = Arthur
***END

6 Executeread-guide-param.tlc with the command:

tlc -r guide.rtw -alist=0 read-guide-param.tlc

With the -alist=0 switch, the output displays only the information outside of the if statement.

 Read Record Files with TLC

16-15



*** WORKING WITH RECORDFILE [guide.rtw]
***END

Review
The preceding exercises examined the structure of record files, and expanded on how to use TLC
directives. The following TLC directives are commonly used in TLC scripts (see “Target Language
Compiler Directives” on page 19-2 for detailed descriptions):

%addincludepath Enable TLC to find included files.
%addtorecord Add fields to existing record. New fields can be name/value

pairs or aliases to existing records.
%assign Create or modify variables.
%copyrecord Create new record and, if applicable, specify subrecords within

them, including name/value pairs. The components of the
record come from the existing record specified.

%createrecord Create new top-level records and, if applicable, specify
subrecords within them, including name/value pairs.

%foreach/%endforeach Iterate loop variable from 0 to upper limit.
%if/%endif Control whether code is executed, as in C.
%include Insert one file into another, as in C.
%mergerecord Combine one or more records. The first record contains itself

plus copies of the other records contents specified by the
command, in sequence.

%selectfile Direct outputs to a stream or file.
%undef var Remove (delete) var (a variable or a record) from scope. If

var is a field in a record, TLC removes the field from the
record. If var is a record array (list), TLC removes the first
element of the array; the remaining elements remain
accessible. Only records created via %createrecord or
%copyrecord can be removed.

%with/%endwith Add scope to simplify referencing blocks.

See Also

Related Examples
• “Target Language Compiler Directives” on page 19-2
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Inline S-Functions with TLC
timesN Tutorial Overview
Objective: To understand how TLC works with an S-function.

Folder: matlabroot/toolbox/rtw/rtwdemos/tlctutorial/timesN (open)

In this tutorial, you generate versions of C code for existing S-function timesN.

The tutorial includes these steps:

1 Noninlined Code Generation — Via SimStructs and generic API
2 Why Use TLC to Inline S-Functions? — Benefits of inlining
3 Create an Inlined S-Function — Via custom TLC code

A later tutorial provides information and practice with “wrapping” S-functions.

Noninlined Code Generation
The tutorial folder tlctutorial/timesN in your working folder contains Simulink S-function
timesN.c.

In this exercise, you generate noninlined code from the model sfun_xN.

1 Find the file rename_timesN.tlc in tlctutorial/timesN. Rename this file to timesN.tlc.
This allows you to generate code.

2 In the MATLAB Command Window, create a MEX-file for the S-function:

mex timesN.c

This avoids picking up the version shipped with Simulink.
3 Open the model sfun_xN, which uses the timesN S-function. The block diagram looks like this.

4 Open the Configuration Parameters dialog box and select the Solver pane.
5 Set Stop time to 10.0.
6 Set the Solver Options.

• Type to Fixed-step
• Solver to Discrete (no continuous states)
• Fixed-step size to 0.01

7 Select the Optimization pane, and make sure that Default parameter behavior is set to
Tunable.
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8 Select the Code Generation > Comments pane, and notice that Include comments is checked
by default.

9 Select the Code Generation pane and check Generate code only.

Click Apply.
10 Press Ctrl+B to generate C code for the model.
11 Open the resulting file sfun_xN_grt_rtw/sfun_xN.c and view the sfun_xN_output portion,

shown below.

/* Model output function */
static void sfun_xN_output(int_T tid)
{
  /* Sin: '<Root>/Sin' */
  sfun_xN_B.Sin = sin(sfun_xN_M->Timing.t[0] * sfun_xN_P.Sin_Freq +
                      sfun_xN_P.Sin_Phase) * sfun_xN_P.Sin_Amp +
    sfun_xN_P.Sin_Bias;

  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by 3.0 */
  sfun_xN_B.timesN_output = sfun_xN_B.Sin * 3.0;

  /* Outport: '<Root>/Out' */
  sfun_xN_Y.Out = sfun_xN_B.timesN_output;
  UNUSED_PARAMETER(tid);
}

Comments appear in the code because, in the Code Generation > Comments pane of the
Configuration Parameters dialog box, Include comments is selected by default.

Why Use TLC to Inline S-Functions?
The code generator includes a generic API that you can use to invoke user-written algorithms and
drivers. The API includes a variety of callback functions — for initialization, output, derivatives,
termination, and so on — as well as data structures. Once coded, these are instantiated in memory
and invoked during execution via indirect function calls. Each invocation involves stack frames and
other overhead that adds to execution time.

In a real-time environment, especially when many solution steps are involved, generic API calls can
be unacceptably slow. The code generator can speed up S-functions in standalone applications that it
generates by embedding user-written algorithms within auto-generated functions, rather than
indirectly calling S-functions via the generic API. This form of optimization is called inlining. TLC
inlines S-functions, resulting in faster, optimized code.

You should understand that TLC is not a substitute for writing C code S-functions. To invoke custom
blocks within Simulink, you still have to write S-functions in C (or as MATLAB files), since simulations
do not make use of TLC files. You can, however, prepare TLC files that inline specified S-functions to
make your target code much more efficient.

Create an Inlined S-Function
TLC creates an inlined S-function whenever it detects a .tlc file with the same name as an S-
function. Assuming the .tlc file has the expected form, it directs construction of code that
functionally duplicates the external S-function without incurring API overhead. See how this process
works by completing the following steps:
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1 If you have not done so already, find the file rename_timesN.tlc in tlctutorial/timesN.
Rename this file to timesN.tlc, so you can use it to generate code. The executable portion of
the file is
%implements "timesN" "C"

%% Function: Outputs ===========================================================
%%
%function Outputs(block, system) Output
  %assign gain =SFcnParamSettings.myGain
  /* %<Type> Block: %<Name> */
  %%
  /* Multiply input by %<gain> */
  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
    %<LibBlockOutputSignal(0, "", lcv, idx)> = \
    %<LibBlockInputSignal(0, "", lcv, idx)> * %<gain>;
  %endroll

%endfunction

2 Create the inline version of the S-function.

a On the Optimization pane of the Configuration Parameters dialog box, set Default
parameter behavior to Inlined, and click Apply.

b Change the diagram’s label from model: sfun_xN to model: sfun_xN_ilp.
c Save the model as sfun_x2_ilp.
d Press Ctrl+B. Source files are created in a new subfolder called sfun_xN_ilp_grt_rtw.
e Inspect the code in generated file sfun_xN_ilp.c:

/* Model output function */
static void sfun_xN_ilp_output(int_T tid)
{
  /* Sin: '<Root>/Sin' */
  sfun_xN_ilp_B.Sin = sin(sfun_xN_ilp_M->Timing.t[0]);

  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by 3.0 */
  sfun_xN_ilp_B.timesN_output = sfun_xN_ilp_B.Sin * 3.0;

  /* Outport: '<Root>/Out' */
  sfun_xN_ilp_Y.Out = sfun_xN_ilp_B.timesN_output;
  UNUSED_PARAMETER(tid);
}

Note When the code generator produces code and builds executables, it creates or uses a
specific subfolder (called the build folder) to hold source, object, and make files. By default,
the build folder is named model_grt_rtw.

Notice that setting Default parameter behavior to Inlined did not change the code. This
is because TLC inlines S-functions.

3 Continue the exercise by creating a standalone simulation.

a In the Code Generation pane of the Configuration Parameters dialog box, clear Generate
code only and click Apply.

b In the Data Import/Export pane of the Configuration Parameters dialog box, check Output.
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This specification causes the model’s output data to be logged in your MATLAB workspace.
c Press Ctrl+B to generate code, compile, and link the model into an executable, named

sfun_xN_ilp.exe (or, on UNIX systems, sfun_xN_ilp).
d Confirm that the timesN.tlc file produces expected output by running the standalone

executable. To run it, in the MATLAB Command Window, type

!sfun_xN_ilp

The following response appears:

** starting the model **
** created sfun_xN_ilp.mat **

e View or plot the contents of the sfun_xN_ilp.mat file to verify that the standalone model
generated sine output ranging from -3 to +3. In the MATLAB Command Window, type

load sfun_xN_ilp.mat
plot (rt_yout)

Tip For UNIX platforms, run the executable program in the Command Window with the syntax !./
executable_name. If preferred, run the executable program from an OS shell with the syntax ./
executable_name. For more information, see “Run External Commands, Scripts, and Programs”.

See Also

Related Examples
• “Write Fully Inlined S-Functions”
• “Write Fully Inlined S-Functions with mdlRTW Routine”

16 Target Language Compiler Tutorials

16-20



Explore Variable Names and Loop Rolling

timesN Looping Tutorial Overview
Objective: This example shows how you can influence looping behavior of generated code.

Folder: matlabroot/toolbox/rtw/rtwdemos/tlctutorial/timesN (open)

Work with the model sfun_xN in tlctutorial/timesN. It has one source (a Sine Wave generator
block), a times N gain block, an Out block, and a Scope block.

The tutorial guides you through following steps:

1 Getting Started — Set up the exercise and run the model
2 Modify the Model — Change the input width and see the results
3 Change the Loop Rolling Threshold — Change the threshold and see the results
4 More About TLC Loop Rolling — Parameterize loop behavior

Getting Started
1 Make tlctutorial/timesN your current folder, so that you can use the files provided.

Note You must use or create a working folder outside of matlabroot for Simulink models you
make. You cannot build models in source folders.

2 In the MATLAB Command Window, create a MEX-file for the S-function:

mex timesN.c

This avoids picking up the version shipped with Simulink.

Note An error might occur if you have not previously run mex -setup.
3 Open the model file sfun_xN.

4 View the previously generated code in sfun_xN_grt_rtw/sfun_xN.c. Note that no loops exist
in the code. This is because the input and output signals are scalar.

Modify the Model
1 Replace the Sine Wave block with a Constant block.
2 Set the parameter for the Constant block to 1:4, and change the top label, model: sfun_xN, to

model: sfun_vec.
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3 Save the edited model as sfun_vec (in tlctutorial/timesN). The model now looks like this.

4 Because the Constant block generates a vector of values, this is a vectorized model. Generate
code for the model and view the /*Model output function */ section of sfun_vec.c in
your editor to observe how variables and for loops are handled. This function appears as
follows:
/* Model output function */
static void sfun_vec_output(int_T tid)
{
  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by 3.0 */
  sfun_vec_B.timesN_output[0] = sfun_vec_P.Constant_Value[0] * 3.0;
  sfun_vec_B.timesN_output[1] = sfun_vec_P.Constant_Value[1] * 3.0;
  sfun_vec_B.timesN_output[2] = sfun_vec_P.Constant_Value[2] * 3.0;
  sfun_vec_B.timesN_output[3] = sfun_vec_P.Constant_Value[3] * 3.0;

  /* Outport: '<Root>/Out' */
  sfun_vec_Y.Out[0] = sfun_vec_B.timesN_output[0];
  sfun_vec_Y.Out[1] = sfun_vec_B.timesN_output[1];
  sfun_vec_Y.Out[2] = sfun_vec_B.timesN_output[2];
  sfun_vec_Y.Out[3] = sfun_vec_B.timesN_output[3];
  UNUSED_PARAMETER(tid);
}

Notice that there are four instances of the code that generates model outputs, corresponding to
four iterations.

5 Set the parameter for the Constant block to 1:10, and save the model.
6 Generate code for the model and view the /*Model output function */ section of

sfun_vec.c in your editor to observe how variables and for loops are handled. This function
appears as follows:
/* Model output function */
static void sfun_vec_output(int_T tid)
{
  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by 3.0 */
  {
    int_T i1;
    const real_T *u0 = &sfun_vec_P.Constant_Value[0];
    real_T *y0 = sfun_vec_B.timesN_output;
    for (i1=0; i1 < 10; i1++) {
      y0[i1] = u0[i1] * 3.0;
    }
  }

  {
    int32_T i;
    for (i = 0; i < 10; i++) {
      /* Outport: '<Root>/Out' */
      sfun_vec_Y.Out[i] = sfun_vec_B.timesN_output[i];
    }
  }

  UNUSED_PARAMETER(tid);
}
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Notice that:

• The code that generates model outputs gets “rolled” into a loop. This occurs by default when the
number of iterations exceeds 5.

• Loop index i1 runs from 0 to 9.
• Pointer *y0 is used and initialized to the output signal array.

Change the Loop Rolling Threshold
The code generator creates iterations or loops depending on the current value of the Loop unrolling
threshold parameter.

The default value of Loop unrolling threshold is 5. To change looping behavior for blocks in a
model:

1 On the Optimization pane of the Configuration Parameters dialog box, set Loop unrolling
threshold to 12 and click Apply.

The parameter RollThreshold is now 12. Loops will be generated only when the width of
signals passing through a block exceeds 12.

Note You cannot modify RollThreshold for specific blocks from the Configuration Parameters
dialog box.

2 Press Ctrl+B to regenerate the output.
3 Inspect sfun_vec.c. It will look like this:

/* Model output function */
static void sfun_vec_output(int_T tid)
{
  /* S-Function Block: <Root>/S-Function */
  /* Multiply input by 3.0 */
  sfun_vec_B.timesN_output[0] = sfun_vec_P.Constant_Value[0] * 3.0;
  sfun_vec_B.timesN_output[1] = sfun_vec_P.Constant_Value[1] * 3.0;
  sfun_vec_B.timesN_output[2] = sfun_vec_P.Constant_Value[2] * 3.0;
  sfun_vec_B.timesN_output[3] = sfun_vec_P.Constant_Value[3] * 3.0;
  sfun_vec_B.timesN_output[4] = sfun_vec_P.Constant_Value[4] * 3.0;
  sfun_vec_B.timesN_output[5] = sfun_vec_P.Constant_Value[5] * 3.0;
  sfun_vec_B.timesN_output[6] = sfun_vec_P.Constant_Value[6] * 3.0;
  sfun_vec_B.timesN_output[7] = sfun_vec_P.Constant_Value[7] * 3.0;
  sfun_vec_B.timesN_output[8] = sfun_vec_P.Constant_Value[8] * 3.0;
  sfun_vec_B.timesN_output[9] = sfun_vec_P.Constant_Value[9] * 3.0;

  /* Outport: '<Root>/Out' */
  sfun_vec_Y.Out[0] = sfun_vec_B.timesN_output[0];
  sfun_vec_Y.Out[1] = sfun_vec_B.timesN_output[1];
  sfun_vec_Y.Out[2] = sfun_vec_B.timesN_output[2];
  sfun_vec_Y.Out[3] = sfun_vec_B.timesN_output[3];
  sfun_vec_Y.Out[4] = sfun_vec_B.timesN_output[4];
  sfun_vec_Y.Out[5] = sfun_vec_B.timesN_output[5];
  sfun_vec_Y.Out[6] = sfun_vec_B.timesN_output[6];
  sfun_vec_Y.Out[7] = sfun_vec_B.timesN_output[7];
  sfun_vec_Y.Out[8] = sfun_vec_B.timesN_output[8];
  sfun_vec_Y.Out[9] = sfun_vec_B.timesN_output[9];
  UNUSED_PARAMETER(tid);
}

4 To activate loop rolling again, change the Loop unrolling threshold to 10 (or less) on the
Optimization pane.
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Loop rolling is an important TLC capability for optimizing generated code. Take some time to study
and explore its implications before generating code for production requirements.

More About TLC Loop Rolling
The following TLC %roll code is the Outputs function of timesN.tlc:
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %%
  /* Multiply input by %<gain> */
  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
     %<LibBlockOutputSignal(0, "", lcv, idx)> = \
    %<LibBlockInputSignal(0, "", lcv, idx)> * %<gain>;
  %endroll
%endfunction %% Outputs

Arguments for %roll

The lines between %roll and %endroll may be either repeated or looped. The key to understanding
the %roll directive is in its arguments:
%roll sigIdx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars

Argument Description
sigIdx Specify the index into a (signal) vector that is used in the generated code.

If the signal is scalar, when analyzing that block of the model.rtw file,
TLC determines that only a single line of code is required. In this case, it
sets sigIdx to 0 so as to access only the first element of a vector, and no
loop is constructed.

lcv A control variable generally specified in the %roll directive as lcv =
RollThreshold. RollThreshold is a global (model-wide) threshold with
the default value of 5. Therefore, whenever a block contains more than five
contiguous and rollable variables, TLC collapses the lines nested between
%roll and %endroll into a loop. If fewer than five contiguous rollable
variables exist, %roll does not create a loop and instead produces
individual lines of code.

block This tells TLC that it is operating on block objects. TLC code for S-
functions use this argument.

"Roller" This, specified in rtw/c/tlc/roller.tlc, formats the loop. Normally
you pass this as is, but other loop control constructs are possible for
advanced uses (see LibBlockInputSignal in “Input Signal Functions”
on page 22-7).

rollVars Tells TLC what types of items should be rolled: input signals, output
signals, and/or parameters. You do not have to use all of them. In a
previous line, rollVars is defined using %assign.

%assign rollVars = ["U", "Y"]

This list tells TLC that it is rolling through input signals (U) and output
signals (Y). In cases where blocks specify an array of parameters instead of
a scalar parameter, rollvars is specified as

%assign rollVars = ["U", "Y", "P"]
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Input Signals, Output Signals, and Parameters

Look at the lines that appear between %roll and %endroll:

%<LibBlockOutputSignal(0, "", lcv, idx)> = \
%<LibBlockInputSignal (0, "", lcv, idx)> * 2.0;

The TLC library functions LibBlockInputSignal and LibBlockOutputSignal expand to produce
scalar or vector identifiers that are named and indexed. LibBlockInputSignal,
LibBlockOutputSignal, and a number of related TLC functions are passed four canonical
arguments:

Argument Description
first argument — 0 Corresponds to the input port index for a given

block. The first input port has index 0. The second
input port has index 1, and so on.

second argument — " " An index variable reserved for advanced use. For
now, specify the second argument as an empty
string. In advanced applications, you may define
your own variable name to be used as an index
with %roll. In such a case, TLC declares this
variable as an integer in a location in the
generated code.

third argument — lcv As described previously, lcv = RollThreshold
is set in %roll to indicate that a loop be
constructed whenever RollThreshold (default
value of 5) is exceeded.

fourth argument — sigIdx Enables TLC to handle special cases. In the event
that the RollThreshold is not exceeded (for
example, if the block is only connected to a scalar
input signal) TLC does not roll it into a loop.
Instead, TLC provides an integer value for the
index variable in a corresponding line of “inline”
code. Whenever the RollThreshold is
exceeded, TLC creates a for loop and uses an
index variable to access inputs, outputs and
parameters within the loop.

See Also

Related Examples
• “Target Language Compiler Directives” on page 19-2
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Debug Your TLC Code

tlcdebug Tutorial Overview
Objective: Introduces the TLC debugger. You will learn how to set breakpoints and familiarize
yourself with TLC debugger commands.

Folder: matlabroot/toolbox/rtw/rtwdemos/tlctutorial/tlcdebug (open)

You can cause the TLC debugger to be invoked whenever the build process is invoked. In this tutorial,
you use it to detect a bug in a .tlc file for a model called simple_log. The bug causes the
generated code output from the standalone version of the model to differ from its simulation output.
The tutorial guides you through following steps:

1 Getting Started — Run the model and inspect output
2 Generate and Run Code from the Model — Compare compiled results to original output
3 Start the Debugger and Use Its Commands — Things you can do with the debugger
4 Debug timesN.tlc — Find out what went wrong
5 Fix the Bug and Verify — Easy ways to fix bugs and verify fixes

Getting Started
1 Copy the files from tlctutorial/tlcdebug to your current working directory.
2 In the MATLAB Command Window, create a MEX-file for the S-function:

mex timesN.c

This avoids picking up the version shipped with your Simulink software.

Note An error might occur if you have not previously run mex -setup.
3 Open the model simple_log. The model looks like this.

4 In the Data Import/Export pane of the Configuration Parameters dialog box, check Time and
Output. This causes model variables to be logged to the MATLAB workspace.

5 Run the model. On the Simulation tab, click Run. Variables tout and yout appear in your
MATLAB workspace.

6 Double-click yout in the Workspace pane of the MATLAB Command Window. The Variable
Editor displays the 6x1 array output from simple_log. The display looks like this:
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Column 1 contains discrete pulse output for six time steps (3s and 0s), collected at port out1.

Next, you generate a standalone version of simple_log. You execute it and compare its results to
the output from Simulink displayed above.

Note For the purpose of this exercise, the TLC file provided, timesN.tlc, contains a bug. This
version must be in the same folder as the model that uses it.

Generate and Run Code from the Model
1 Press Ctrl+B.

The code generator produces, compiles, and links C source code. The MATLAB Command
Window shows the progress of the build, which ends with these messages:

### Created executable: simple_log.exe  
### Successful completion of build procedure 
    for model: simple_log

2 Run the standalone model just created by typing

!simple_log

This results in the messages

** starting the model **
** created simple_log.mat **

3 Inspect results by placing the variables in your workspace. In the Current Folder pane, double-
click simple_log.mat, then double-click rt_yout (the standalone version of variable yout) in
the Workspace pane.

Compare rt_yout with yout. Do you notice differences? Can you surmise what caused values in
rt_yout to change?

A look at the generated C code that TLC placed in your build folder (simple_log_grt_rtw)
helps to identify the problem.

4 Edit simple_log.c and look at its MdlOutputs function, which should appear as shown below:
/* Model output function */
static void simple_log_output(void)
{
  /* DiscretePulseGenerator: '<Root>/Discrete Pulse Generator' */
  simple_log_B.DiscretePulseGenerator = (simple_log_DW.clockTickCounter < 1.0) &&
    (simple_log_DW.clockTickCounter >= 0) ? 1.0 : 0.0;
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  if (simple_log_DW.clockTickCounter >= 2.0 - 1.0) {
    simple_log_DW.clockTickCounter = 0;
  } else {
    simple_log_DW.clockTickCounter++;
  }

  /* End of DiscretePulseGenerator: '<Root>/Discrete Pulse Generator' */

  /* S-Function (timesN): '<Root>/Gain1st' incorporates:
   *  Outport: '<Root>/Out1'
   */
  /* S-Function Block: <Root>/Gain1st */
  /* Multiply input by 3.0 */
  simple_log_Y.Out1 = simple_log_B.DiscretePulseGenerator * 1;
}

Note the line near the end:

simple_log_B.first_output = simple_log_B.DiscretePulseGenerator * 1;

How did the incorrect product get assigned to the output when it was supposed to receive a variable
that alternates between 3.0 and 0.0? Use the debugger to find out.

Start the Debugger and Use Its Commands
You use the TLC debugger to monitor the code generation process. As it is not invoked by default, you
need to request the debugger explicitly.

1 Set up the TLC debugging environment and start to build the application:

a Select the Configuration Parameters > Code Generation pane, and select the options
Retain .rtw file and Start TLC debugger when generating code. Click OK.

b Build the model.

The MATLAB Command Window describes the building process. The build stops at the
timesN.tlc file and displays the command prompt:

TLC-DEBUG>
2 Type help to list the TLC debugger commands. Here are some things you can do in the

debugger.

• View and query various entities in the TLC scope.

TLC-DEBUG> whos CompiledModel
TLC-DEBUG> print CompiledModel.NumSystems
TLC-DEBUG> print TYPE(CompiledModel.NumSystems)

• Examine the statements in your current context.

TLC-DEBUG> list
TLC-DEBUG> list 10,40

• Move to the next line of code.

TLC-DEBUG> next

• Step into a function.

TLC-DEBUG> step

• Assign a constant value to a variable, such as the input signal %<u>.
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TLC-DEBUG> assign u = 5.0

• Set a breakpoint where you are or in some other part of the code.

TLC-DEBUG> break timesN.tlc:10

• Execute until the next breakpoint.

TLC-DEBUG> continue

• Clear breakpoints you have established.

TLC-DEBUG> clear 1
TLC-DEBUG> clear all

3 If you have tried the TLC debugger commands, execute the remaining code to finish the build
process, then build simple_log again. The build stops at the timesN.tlc file and displays the
command prompt:

TLC-DEBUG>

Debug timesN.tlc
Now look around to find out what is wrong with the code:

1 Set a breakpoint on line 20 of timesN.tlc.
TLC-DEBUG> break timesN.tlc:20

2 Instruct the TLC debugger to advance to your breakpoint.
TLC-DEBUG> continue

TLC processes input, reports its progress, advances to line 20 in timesN.tlc, displays the line,
and pauses.
### Loading TLC function libraries
...
### Initial pass through model to cache user defined code
.
### Caching model source code
.
Breakpoint 1
00020:   %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars

3 Use the whos command to see the variables in the current scope.
TLC-DEBUG> whos
Variables within: <BLOCK_LOCAL>
gain                           Real
rollVars                       Vector
block                          Resolved
system                         Resolved

4 Inspect the variables using the print command (names are case sensitive).
TLC-DEBUG> print gain
3.0

TLC-DEBUG> print rollVars
[U, Y]

5 Execute one step.
TLC-DEBUG> step
00021:     %<LibBlockOutputSignal(0, "", lcv, idx)> = \

6 Because it is a built-in function, advance via the next command.
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TLC-DEBUG> next
.
00022:     %<LibBlockInputSignal(0, "", lcv, idx)> * 1;

This is the origin of the C statement responsible for the erroneous constant output,
simple_log_B.first_output = simple_log_B.DiscretePulseGenerator * 1;.

7 Abandon the build by quitting the TLC debugger. Type
TLC-DEBUG> quit

An error message is displayed showing that you stopped the build by using the TLC debugger
quit command. Close the error window.

Fix the Bug and Verify
The problem you identified is caused by evaluating a constant rather than a variable inside the TLC
function FcnEliminateUnnecessaryParams(). This is a typical coding error and is easily repaired.
Here is the code you need to fix.
%function Outputs(block, system) Output
   %assign gain =SFcnParamSettings.myGain
  /* %<Type> Block: %<Name> */
  %%
  /* Multiply input by %<gain> */
  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
    %<LibBlockOutputSignal(0, "", lcv, idx)> = \
    %<LibBlockInputSignal(0, "", lcv, idx)> * 1;
  %endroll

%endfunction

%% [EOF] timesN.tlc

1 To fix the coding error, edit timesN.tlc. The line

%<LibBlockInputSignal(0, "", lcv, idx)> * 1;

multiplies the evaluated input by 1. Change the line to

%<LibBlockInputSignal(0, "", lcv, idx)> * %<gain>;

Save timesN.tlc.
2 Build the standalone model again. Complete the build by typing continue at each TLC-DEBUG>

prompt.
3 Execute the standalone model by typing

!simple_log

A new version of simple_log.mat is created containing its output.
4 Load simple_log.mat and compare the workspace variable rt_yout with yout, as you did

before. The values in the first column should now correspond.

See Also

Related Examples
• “TLC Code Coverage to Aid Debugging” on page 16-32
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• “Using the TLC Debugger” on page 20-2
• “TLC Coverage” on page 20-6
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TLC Code Coverage to Aid Debugging

tlcdebug Execute Tutorial Overview
Objective: Learn to use TLC coverage statistics to help identify bugs in TLC code.

Folder: matlabroot/toolbox/rtw/rtwdemos/tlctutorial/tlcdebug (open)

This tutorial teaches you how to determine whether your TLC code is being executed as expected.
Here it uses the same model as for the previous tutorial. As you focus on understanding flow of
control in processing TLC files, you don’t need to compile and execute a standalone model, only to
look at code. The tutorial proceeds as follows:

1 Getting Started — Why and how to analyze TLC coverage
2 Open the Model and Generate Code — Read a coverage log file

Getting Started
The Code Generation > Debug pane provides the option Start TLC coverage when generating
code. Selecting it results in a listing that documents how many times each line in your TLC source
file was executed during code generation. The listing, name.log (where name is the filename of the
TLC file being analyzed), is placed in your build folder.

Note A log file for every .tlc file invoked or included is generated in the build folder. Focus on
timesN.log.

Open the Model and Generate Code
1 Copy the folder tlctutorial/tlcdebug/ to your working folder and cd to it. Do this even

though you already have copied it, to be sure you have the version of timesN.tlc that has the
bug.

2 In the MATLAB Command Window, create a MEX-file for the S-function.

mex timesN.c

This avoids picking up the version shipped with your Simulink software.
3 Open the model simple_log.
4 In the Code Generation pane of the Configuration Parameters dialog box, check Generate code

only.
5 In the Code Generation > Debug pane of the Configuration Parameters dialog box, select Start

TLC coverage when generating code. (Do not select Start TLC debugger when generating
code. Invoking the debugger is unnecessary.) Click Apply.

6 Press Ctrl+B. The usual messages appear in the MATLAB Command Window, and a build folder
(simple_log_grt_rtw) is created in your working folder.

7 Enter the build folder. Find the file timesN.log, and copy it to your working folder, renaming it
to timesN_ilp.log to prevent it from being overwritten.
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8 Open the log file timesN_ilp.log in your editor. It looks almost like timesN.tlc, except for a
number followed by a colon at the beginning of each line. This number represents the number of
times TLC executed the line in generating code. The code for Outputs() should look like this:
0: %% Function: Outputs ========================================================
     0: %%
     1: %function Outputs(block, system) Output
     1:   %assign gain =SFcnParamSettings.myGain
     1:   /* %<Type> Block: %<Name> */
     0:   %%
     1:   /* Multiply input by %<gain> */
     1:   %assign rollVars = ["U", "Y"]
     1:   %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
     1:     %<LibBlockOutputSignal(0, "", lcv, idx)> = \
     1:     %<LibBlockInputSignal(0, "", lcv, idx)> * 1;
     0:   %endroll
     1: 
     0: %endfunction

Notice that comments were not executed. TLC statements were reached, which means they
output to the generated C code as many times as the number prefixed to those lines.

Changing code generation options can cause a latent issue in generated source code. Systematically
changing options and observing the resulting differences in TLC coverage can facilitate the process
of discovering faulty code.

See Also

Related Examples
• “Using the TLC Debugger” on page 20-2
• “TLC Coverage” on page 20-6
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Wrap User Code with TLC

wrapper Tutorial Overview
Objective: Learn the architecture of wrapper S-functions and how to create an inlined wrapper S-
function using TLC.

Folder: matlabroot/toolbox/rtw/rtwdemos/tlctutorial/wrapper (open)

Wrapper S-functions enable you to use existing C functions without fully rewriting them in the
context of Simulink S-functions. Each wrapper you provide is an S-function “shell” that merely calls
one or more existing, external functions. This tutorial explains and illustrates wrappers as follows:

• Why Wrap User Code? — Reason for building TLC wrapper functions
• Getting Started — Set up the wrapper exercise
• Generate Code Without a Wrapper — How the code generator handles external functions by

default
• Generate Code Using a Wrapper — Bypass the API overhead

Why Wrap User Code?
Many Simulink users want to build models incorporating algorithms that they have already coded,
implemented, and tested in a high-level language. Typically, such code is brought into Simulink as S-
functions. To generate an external application that integrates user code, you can take several
approaches:

• You can construct an S-function from user code that hooks it to the Simulink generic API. This is
the simplest approach, but sacrifices efficiency for standalone applications.

• You can inline the S-function, reimplementing it as a TLC file. This improves efficiency, but takes
time and effort, can introduce errors into working code, and leads to two sets of code to maintain
for each algorithm, unless you use the Legacy Code Tool (see “Import Calls to External Code into
Generated Code with Legacy Code Tool”).

• You can inline the S-function via a TLC wrapper function. By doing so, you need to create only a
small amount of TLC code, and the algorithm can remain coded in its existing form.

The next figure illustrates how S-function wrappers operate.
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Wrapping a function eliminates the need to recode it, requiring only a bit of extra TLC code to
integrate it. Wrappers also enable object modules or libraries to be used in S-functions. This may be
the only way to deploy functions for which source code is unavailable, and also allows users to
distribute models to others without divulging implementation details that may be proprietary.

For example, you might have an existing object file compiled for a processor on which Simulink does
not run. You can write a dummy C S-function and use a TLC wrapper that calls the external function,
despite not having its source code. You could similarly access functions in a library of algorithms
optimized for the target processor. Accomplishing this requires making changes to a template
makefile, or otherwise providing a means to link against the library.

Note Object files that lack source code and are created with Microsoft Visual C and Microsoft Visual
C++® Compiler (MSVC) work only with MSVC.

The only restriction on S-function wrappers is for the number of block inputs and outputs match
number of inputs and outputs of the wrapped external function. Wrapper code may include
computations, but usually these are limited to transforming values (for example, scaling or
reformatting) passed to and from the wrapped external functions.
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Getting Started
In the example folder, the “external function” is found in the file my_alg.c. You are also provided
with a C S-function called wrapsfcn.c that integrates my_alg.c into Simulink. Set up the exercise
as follows:

1 Make tlctutorial/wrapper your current folder.
2 In MATLAB, open the model externalcode from your working folder. The block diagram looks

like this:

3 Activate the Scope block by double-clicking it.
4 Run the model (from the Simulation tab, or type Ctrl+T). You will get an error telling you that

wrapsfcn does not exist. Can you figure out why?
5 The error occurs because a mex file does not exist for wrapsfcn. To rectify this, in the MATLAB

Command Window type

mex wrapsfcn.c

Note An error might occur if you have not previously run mex -setup.
6 Run the simulation again with the S-function present.

The S-Function block multiplies its input by two. Looking at the Scope block, you see a sine wave that
oscillates between -2.0 and 2.0. The variable yout that is created in your MATLAB workspace steps
through these values.

In the remainder of the exercise, you build and run a standalone version of the model, then write
some TLC code that allows the code generator to build a standalone executable that calls the S-
function my_alg.c directly.

Generate Code Without a Wrapper
Before creating a wrapper, generate code that uses the Simulink generic API. The first step is to build
a standalone model.

1 On the C Code tab, click Build.

The code generator creates the standalone program in your working folder and places the source
and object files in your build folder. The file will be called externalcode.exe on Microsoft
Windows platforms or externalcode on UNIX platforms.

As it generates the program, the code generator reports its progress in the MATLAB Command
Window. The final lines are:

16 Target Language Compiler Tutorials

16-36



### Created executable: externalcode.exe  
### Successful completion of build procedure 
for model: externalcode

2 Run the standalone program to see that it behaves the same as the Simulink version. There
should not be differences.

!externalcode
 
** starting the model ** 
** created externalcode.mat ** 

3 Notice this line in wrapsfcn.c:

#include "my_alg.c"

This pulls in the external function. That function consists entirely of

/*
 * Copyright 1994-2002 The MathWorks, Inc.
 */

double my_alg(double u)
{
    return(u * 2.0);
}

Inspect the mdlOutputs() function of the code in wrapsfcn.c to see how the external function
is called.

static void mdlOutputs(SimStruct *S, int tid)
{
    int_T             i;    
    InputRealPtrsType uPtrs = ssGetInputPortRealSignalPtrs(S,0);
    real_T            *y    = ssGetOutputPortRealSignal(S,0);
    int_T             width = ssGetOutputPortWidth(S,0);

    *y = my_alg(*uPtrs[0]);
}

Tip For UNIX platforms, run the executable program in the Command Window with the syntax !./
executable_name. If preferred, run the executable program from an OS shell with the syntax ./
executable_name. For more information, see “Run External Commands, Scripts, and Programs”.

Generally, functions to be wrapped are either included in the wrapper, as above, or, when object
modules are being wrapped, resolved at link time.

Generate Code Using a Wrapper
To create a wrapper for the external function my_alg.c, you need to construct a TLC file that
embodies its calling function, wrapsfcn.c. The TLC file must generate C code that provides:

• A function prototype for the external function that returns a double, and passes the input double
u.

• A function call to my_alg() in the outputs section of the code.
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To create a wrapper for my_alg(), do the following:

1 Open the file change_wrapsfcn.tlc in your editor, and add lines of code where comments
indicate to create a workable wrapper.

2 Save the edited file as wrapsfcn.tlc. It must have the same name as the S-function block that
uses it or TLC is not called to inline code.

3 In MATLAB, open the model externalcode from your working folder. Activate the Scope block
by double-clicking it, and run the model (from the Simulation tab, or type Ctrl+T). This gives
you a baseline result.

4 Inform Simulink that your code has an external reference to be resolved. To update the model’s
parameters, in the MATLAB Command Window, do one of the following:

• Type

set_param('externalcode/S-Function','SFunctionModules','my_alg')
• In the S-Function block parameters dialog box, in the S-function modules field, specify

'my_alg'.
5 Create the standalone application, by entering one of the following commands in the Command

Window:

slbuild('my_alg','ForceTopModelBuild',true)

slbuild('my_alg', 'StandaloneCoderTarget','ForceTopModelBuild',true)

These commands force the code generator to rebuild the top model, which is required when you
make changes associated with external or custom code.

Alternatively, you can force regeneration of top model code by deleting folders in the code
generation folder, such as slprj or the generated model code folder.

For more information, see “Control Regeneration of Top Model Code”.
6 Run the new standalone application and verify that it yields identical results as in the scope

window.

!externalcode

If you had problems building the application:

• Find the error messages and try to determine what files are at fault, paying attention to which
step (code generation, compiling, linking) failed.

• Be sure you issued the set_param() command as specified above.
• Chances are that problems can be traced to your TLC file. It may be helpful to use TLC debugger

to step through wrapsfcn.tlc.
• As a last resort, look at wrapsfcn.tlc in the solutions/tlc_solution folder, also listed

below:

%% File    : wrapsfcn.tlc
%% Abstract:
%%      Example tlc file for S-function wrapsfcn.c
%%
%% Copyright 1994-2002 The MathWorks, Inc.
%%
%% 
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%implements "wrapsfcn" "C"

%% Function: BlockTypeSetup ================================
%% Abstract:
%%      Create function prototype in model.h as:
%%        "extern double my_alg(double u);" 
%%
%function BlockTypeSetup(block, system) void
  %openfile buffer
  %% ASSIGNMENT: PROVIDE A LINE OF CODE AS A FUNCTION PROTOTYPE
  %% FOR "my_alg" AS DESCRIBED IN THE WRAPPER TLC ASSIGNMENT 
  extern double my_alg(double u);

  %closefile buffer
  %<LibCacheFunctionPrototype(buffer)>
%endfunction %% BlockTypeSetup

%% Function: Outputs =======================================
%% Abstract:
%%      y = my_alg( u );
%%
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %assign u = LibBlockInputSignal(0, "", "", 0)
  %assign y = LibBlockOutputSignal(0, "", "", 0)
  %% PROVIDE THE CALLING STATEMENT FOR "wrapfcn"
  %<y> = my_alg( %<u> );
%endfunction %% Outputs

Look at the highlighted lines. Did you declare my_alg() as extern double? Did you call
my_alg() with the expected input and output? Fix mistakes and rebuild the model.

See Also

Related Examples
• “Write Wrapper S-Function and TLC Files”
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Code Generation Architecture

• “Build Process” on page 17-2
• “Configure TLC” on page 17-5
• “Code Generation Concepts” on page 17-7
• “TLC Files” on page 17-11
• “Data Handling with TLC” on page 17-14
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Build Process

Build Process Overview
TLC compiles files written in the target language. The target language is an interpreted language and
the compiler operates on source files every time it executes. You can change a target file and watch
the effects of your change the next time you build a model. You do not need to recompile TLC binary
or other large binary to see the changes.

Because the target language is an interpreted language, some statements might not be compiled or
executed (and hence not checked by the compiler). For example:

%if 1
   Hello
%else
   %<Invalid_function_call()>
%endif

In this example, the Invalid_function_call statement is not executed. This example emphasizes
that you should test TLC code with test cases that execute every line.

Create and Use Target Language File
This example creates a target language file that generates specific text from a model. It shows the
sequence of steps that you should follow in creating and using your own target language files.

Process

To begin, create the Simulink model shown in the next figure.

1 Save the new model in a working folder as basic.
2 Display the Configuration Parameters dialog box.
3 Select the Solver pane.
4 In the Solver pane:

a Select Fixed-step in the Type field.
b Select discrete (no continuous states) in the Solver field.
c Under Additional options, specify 0.1 in the Fixed-step size field. (Otherwise, the code

generator posts a warning and supplies a value when you generate code.)
5 Click Apply.
6 Select the Code Generation pane.
7 Select Retain .rtw file, then click Apply. This step lets you inspect the contents of the

model.rtw file after the build finishes.
8 Select Generate code only, then click OK.
9 Build the model.
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The build process generates code in the basic_grt_rtw folder. You can see the progress in the
MATLAB Command Window. When code generation is complete, following message is displayed:
### Successful completion of code generation for model: basic

The slbuild Command

Invoke slbuild by pressing Ctrl+B in the model window. However, some circumstances require you
to execute slbuild directly from the MATLAB prompt.

To generate a model.rtw file from the MATLAB prompt, type:

slbuild('model')

You can specify other options to slbuild that build or rebuild model reference simulation targets or
a stand-alone executable. For more information, type:

help slbuild

at the MATLAB prompt or see slbuild in the Simulink documentation.

Viewing the basic.rtw File

A model.rtw file contains a hierarchy of labeled records and fields. Each record is delimited by
brackets, and contains subordinate records and/or fields. The labels state the purpose of each record
and field. The records and fields in the model.rtw file created for a model describe various details of
the model and the Configuration Parameter settings that specify its context.

Open the file ./basic_grt_rtw/basic.rtw, in MATLAB or a text editor.

Create the Target File

Note The following exercise is provided to give a conceptual overview of how the .rtw file is used in
the build process. The code generator does not support manually invoking TLC with a .rtw file
created from an earlier build. Also, the contents of the .rtw file are undocumented and subject to
change. The basic.tlc file shows how information is provided in a .rtw file that can be accessed by
the TLC files and executed as part of the build process.

Next, create a basic.tlc file to act as a target file for this model. Instead of generating code, simply
display some information about the model using this file. The concept is the same as used in code
generation.

Create a file called basic.tlc in the folder containing basic. This file should contain the following
lines:
%with CompiledModel  

My model is called %<Name>.
It was generated on %<GeneratedOn>.
It has %<NumModelOutputs> output(s) and %<NumContStates> continuous state(s).

%endwith

Note In the build process, the .tlc file specified on the command line when TLC is invoked (for
example, grt.tlc) is referred to as the System Target File (STF). It can be selected via the System
target file browser option in the Code Generation pane of the Configuration Parameters dialog box.
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In this example, you generate the .rtw file as part of the build process and then manually run TLC
using the file basic.tlc as an example STF. basic.tlc illustrates (in a limited capacity) how .rtw
file information is used to generate an example output. To do this, enter at the MATLAB prompt:

slbuild('basic') 
tlc -r basic_grt_rtw/basic.rtw basic.tlc -v

The first line generates the .rtw file in the build folder 'basic_grt_rtw'. This step is unnecessary
because the file has already been generated in the previous step. However, it is useful if the model is
changed and the operation has to be repeated.

The second line runs TLC on the file basic.tlc. The -r option tells TLC that it should use the file
basic.rtw as the .rtw file. Note that a space must separate -r and the input filename. The -v
option tells TLC to be verbose in reporting its activity.

The output of this pair of commands is (date will differ):

My model is called basic.
It was generated on Wed Jun 22 20:51:11 2005.
It has 1 output(s) and 0 continuous state(s).

You can also try changing the model (for instance, by using rand(2,2) as the value for the constant
block) and then repeating the process to see how the output of TLC changes.

See Also

Related Examples
• “Configure TLC” on page 17-5
• “TLC Files” on page 17-11
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Configure TLC
In this section...
“Set Command-Line Arguments” on page 17-5
“Configure for TLC Debugging” on page 17-6

Set Command-Line Arguments
You can enter TLC command-line arguments from the MATLAB command line using the set_param
command, the model parameter TLCOptions, and the TLC option -a. For example, to enter the TLC
command-line string -amyConfigVariable=1, use the following MATLAB command:
set_param(modelName,'TLCOptions','-amyConfigVariable=1');

Using -amyConfigVariable=1 is equivalent to coding the following in your target file:

%assign myConfigVariable = 1

Alternatively, you can configure the TLC code generation process by using the -a option on the TLC
command line. That is, you must give the TLC command interactively.

You can repeatedly use the -a option.

For an example of how this process works, consider the following TLC code fragment:

%if !EXISTS(myConfigVariable)
  %assign myConfigVariable = 0 
%endif
  %if (myConfigVariable == 1)
      code fragment 1
  %else      
      code fragment 2
  %endif

If you specify-amyConfigVariable=1 in the command line, code fragment 1 is generated;
otherwise code fragment 2 is generated. The if block starting with

%if !EXISTS(myConfigVariable)

serves to set the default value of myConfigVariable to 0, so that TLC does not generate an error if
you forget to add -amyConfigVariable to the command line.

If you use the -a option to input a string variable, the variable must be enclosed in double quotation
marks:

-aMyStringVariable="hello"

However, if the string contains white space, enclose the string within apostrophes and double
quotation marks:

-aMyStringVariable="'hello world'"

Do this if apostrophes exist within the string, whether or not white space is included, and the
apostrophes must be escaped (doubled):

-aMyStringVariable="'can''t'"
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Configure for TLC Debugging
To configure TLC for debugging via the Configuration Parameters dialog box, search for the option
Start TLC debugger when generating code. To activate TLC debugger, select Start TLC
debugger when generating code. For more information, see “Using the TLC Debugger” on page
20-2 and the debugging topics in “Target Language Compiler”.

See Also

Related Examples
• “Build Process” on page 17-2
• “TLC Files” on page 17-11
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Code Generation Concepts
TLC interprets a target language, which is a general programming language, and you can use it as
such. It is important, however, to remember that TLC was designed for one purpose: to convert a
model.rtw file to generated code. Thus, the target language provides many features that are useful
for this task but does not provide some of the features that other languages like C and C++ provide.

You might find some of the following general programming examples useful to familiarize yourself
with the basic constructs used within TLC.

Output Streams
The typical “Hello World” example is rather simple in the target language. Type the following in a file
named hello.tlc:

%selectfile STDOUT 
Hello, World

To run this TLC program, type

tlc hello.tlc

at the MATLAB prompt.

This simple script illustrates some important concepts underlying the purpose (and hence the design)
of TLC. Since the primary purpose of TLC is to generate code, it is output (or stream) oriented. It
makes it easy to handle buffers of text and output them easily. In the above script, the %selectfile
directive tells TLC to send any following text that it generates or does not recognize to the standard
output device. Syntax that TLC recognizes begins with the % character. Because Hello, World is
not recognized, it is sent directly to the output. You could easily change the output destination to be a
file. Do not open the STDOUT stream, but select to write to the Command Window.

%openfile foo = "foo.txt"  
%openfile bar = "bar.txt" 
%selectfile foo 
This line is in foo. 
%selectfile STDOUT 
Line has been output to foo. 
%selectfile bar 
This line is in bar. 
%selectfile NULL_FILE 
This line will not show up anywhere. 
%selectfile STDOUT 
About to close bar. 
%closefile bar 
%closefile foo

You can switch between buffers to display status messages. The semantics of the three directives
%openfile, %selectfile, and %closefile are given in “Target Language Compiler Directives” on
page 19-2.

Variable Types
The absence of explicit type declarations for variables is another feature of TLC. See “Target
Language Compiler” for more information on the implicit data types of variables.
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Records
One of the constructs most relevant to generating code from the model.rtw file is a record. A record
is similar to a structure in C or a record in Pascal. The syntax of a record declaration is

%createrecord recVar { ...     
   field1        value1  ...
   field2        value2 ...
      ...     
  fieldN        valueN ... 
}

where recVar is the name of the record being declared, fieldi is a string, and valuei is the
corresponding TLC value.

Records can have nested records, or subrecords, within them. The model.rtw file is essentially one
large record, named CompiledModel, containing levels of subrecords.

Unlike MATLAB, TLC requires that you explicitly load function definitions not located in the same
target file. In MATLAB, the line A = myfunc(B) causes MATLAB to automatically search for and
load a MATLAB file or MEX-file named myfunc. TLC requires that you specifically include the file that
defines the function using the %addincludepath directive.

TLC provides a %with directive that facilitates using records. See “Target Language Compiler
Directives” on page 19-2.

Note  The format and structure of the model.rtw file are subject to change from one release of the
code generator to another.

A record read in from a file is changeable, like other records that you declare in a program. The
record CompiledModel is modified many times during code generation. CompiledModel is the
global record in the model.rtw file. It contains variables used for code generation, such as
NumNonvirtSubsystems, NumBlocks. It is also appended during code generation with many new
variables, options, and subrecords.

Functions such as LibGetFormattedBlockPath are provided in TLC libraries located in
matlabroot/rtw/c/tlc/lib/*.tlc (open). For a complete list of available functions, refer to TLC
Function Library Reference on “Target Language Compiler”.

Assign Values to Fields of Records

To assign a value to a field of a record, you must use a qualified variable expression. A qualified
variable expression references a variable in one of the following forms:

• An identifier
• A qualified variable followed by “.” followed by an identifier, such as

var[2].b

• A qualified variable followed by a bracketed expression such as

var[expr]
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Record Aliases
In TLC, it is possible to create what is called an alias to a record. Aliases are similar to pointers to
structures in C. You can create multiple aliases to a single record. Modifications to the aliased record
are visible to every place that holds an alias.

The following code fragment illustrates the use of aliases:

%createrecord foo { field 1 }
%createrecord a { } 
%createrecord b { } 
%createrecord c { }  

%addtorecord a foo foo 
%addtorecord b foo foo 
%addtorecord c foo { field 1 }  

%% notice we are not changing field through a or b. 
%assign foo.field  = 2  

ISALIAS(a.foo) = %<ISALIAS(a.foo)>
ISALIAS(b.foo) = %<ISALIAS(b.foo)>
ISALIAS(c.foo) = %<ISALIAS(c.foo)>

a.foo.field = %<a.foo.field>
b.foo.field = %<b.foo.field> 
c.foo.field = %<c.foo.field> 
%% note that c.foo.field is unchanged

Saving this script as record_alias.tlc and invoking it with

tlc -v record_alias.tlc

produces the output

ISALIAS(a.foo) = 1
ISALIAS(b.foo) = 1
ISALIAS(c.foo) = 0

a.foo.field = 2
b.foo.field = 2 
c.foo.field = 1 

When inside a function, it is possible to create an alias to a locally created record that is within the
function. If the alias is returned from the function, it remains valid even after exiting the function, as
in the following example:

%function func(value) Output   
  %createrecord foo { field value }
  %createrecord a { foo foo }
ISALIAS(a.foo) = %<ISALIAS(a.foo)>
   %return a.foo
 %endfunction

 %assign x = func(2)
 ISALIAS(x) = %<ISALIAS(x)>
 x = %<x>
 x.field = %<x.field>
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Saving this script as alias_func.tlc and invoking it with

tlc -v alias_func.tlc

produces the output

ISALIAS(a.foo) = 1 
ISALIAS(x) = 1
x = { field 2 } 
x.field = 2

As long as there is some reference to a record through an alias, that record is not deleted. This allows
records to be used as return values from functions.

See Also

Related Examples
• “Target Language Compiler Directives” on page 19-2
• “Data Handling with TLC” on page 17-14
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TLC Files

In this section...
“TLC Program” on page 17-11
“Available Target Files” on page 17-11
“Target File Usage” on page 17-12
“System Target Files” on page 17-13

TLC Program
Target Language Compiler (TLC) works with the Simulink software to generate code.

A TLC program is a collection of ASCII files called scripts. Because TLC is an interpreted language,
there are no object files. The single target file that calls (with the %include directive) other target
files used for the program is called the entry point.

Available Target Files
TLC interprets the set of target files to transform the partial representation of the Simulink model
(model.rtw) into target-specific code.

Target files provide you with the flexibility to customize the code generated by the compiler. For
example, if you use the available system target files, you produce generic C or C++ code from your
Simulink model. This executable code is not platform-specific.

Note Do not customize TLC files even though the capability exists to do so. Such TLC customizations
might not be applied during the code generation process and can lead to unpredictable results.
Customize only the TLC files that you create.
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The parameters in the target files are read from the model.rtw file and looked up by using block
scoping rules. You can define additional parameters within the target files by using the %assign
statement.

Use target language directives to write target files. “Target Language Compiler Directives” on page
19-2 provide complete descriptions of the block scope rules and the target language directives.

“model.rtw File and Scopes” on page 18-2 describes model.rtw file, which is useful for creating
and modifying target files.

In the context of code generation, there are two types of target files:

• System target files

System target files determine the overall framework of code generation. They determine when
blocks are executed, how data is logged, and so on.

• Block target files

Each block has a target file that determines what code should be generated for the block. The
code can vary depending on the exact parameters of the block or the types of connections to it
(e.g., wide vs. scalar input). For more information, see “Block Target File Methods” on page 21-
21

Model-Wide Target Files and System Target Files

You use model-wide target files on a model-wide basis. Model-wide target files provide basic
information to TLC, which transforms the model.rtw file into target-specific code.

The system target file is the entry point for TLC. It is analogous to the main() routine of a C
program. System target files oversee the entire code generation process. For example, the system
target file grt.tlc sets up some variables for codegenentry.tlc, which is the entry point into the
system target files. For a complete list of available system target files, see “Compare System Target
File Support Across Products”.

Target File Usage
Use the target files to:

• Inline an S-function

Inlining an S-function means writing a block target file that instructs TLC how to generate code
for that S-Function block. The compiler can generate code for noninlined C MEX S-functions. If
you inline a C MEX S-function, the compiler can generate more efficient code. Noninlined C MEX
S-functions execute by using the S-function application program interface (API) and can be
inefficient. You can inline a MATLAB file or Fortran S-function. TLC can generate code for the S-
function in both cases.

• Customize the code generated for all models

You might want to instrument the generated code for profiling or make other changes to overall
code generation for all models. To accomplish such changes, modify some of the system target
files.
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System Target Files
The entire code generation process starts with the single system target file that you specify in the
Configuration Parameters dialog box, on the Code Generation pane. Click the Browse button to
activate the system target file browser for this purpose. A close examination of a system target file
reveals how code generation occurs. This listing is a listing of the non-comment lines in grt.tlc, the
target file to generate code for a generic real-time executable.

%selectfile NULL_FILE
%assign TargetType = "RT" 
%assign Language   = "C"  
%assign MatFileLogging = 1 
%include "codegenentry.tlc"

The three variables, Language, TargetType, and MatFileLogging, are global TLC variables that
other functions use. Code generation is then initiated by the call to codegenentry.tlc, the main
entry point for code generation.

If you want to modify overall code generation, you must change the system target file. After the initial
setup, instead of calling codegenentry.tlc, you must call your own TLC files. This code shows an
example system target file called mygrt.tlc.

%% Set up variables, etc.
%% Load my library functions 
%% Note that mylib.tlc should %include funclib.tlc at the  
%% beginning. 
%include "mylib.tlc"  
%include "commonsetup.tlc"  

%% Next, you can include TLC files that you need for 
%% preprocessing information about the model and to fill in 
%% hooks. The following is an example of including a single
%% TLC file that contains custom hooks. 
%include "myhooks.tlc"  

%% Finally, call the code generator. 
%include "commonentry.tlc"

Generated code is placed in a model or subsystem function. The relevant generated function names
and their execution order are described in “Execution of Code Generated from a Model” and
“Configure C Code Generation for Model Entry-Point Functions”. During code generation, functions
from each of the block target files are executed and the generated code is placed in model or
subsystem functions.

See Also

Related Examples
• “Build Process” on page 17-2
• “Data Handling with TLC” on page 17-14
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Data Handling with TLC
In this section...
“Matrix Parameters” on page 17-14
“Code Generator Matrix Parameters” on page 17-14

Matrix Parameters
MATLAB, Simulink, and the code generator use column-major ordering for array storage (1-D, 2-
D, ...). The next element of an array in memory is accessed by incrementing the first index of the
array. For example, these element pairs are stored sequentially in memory: A(i) and A(i+1),
B(i,j) and B(i+1,j), C(i,j,k) and C(i+1,j,k). For more information on the internal
representation of MATLAB data, see “MATLAB Data”.

Code Generator Matrix Parameters
Simulink and code generator internal data storage formatting differs from MATLAB internal data
storage formatting only in the storage of complex number arrays. In MATLAB, the real and imaginary
parts are stored in separate arrays. In the Simulink and code generator products they are stored in
an "interleaved" format, where the numbers in memory alternate real, imaginary, real, imaginary, and
so forth. This convention allows efficient implementations of small signals on Simulink lines and for
Mux blocks and other "virtual" signal manipulation blocks (that is, they do not actively copy their
inputs, merely the references to them).

The compiled model file, model.rtw, represents matrices as strings in MATLAB syntax, with no
implied storage format. This is so you can copy the string out of an .rtw file and paste it into
MATLAB code and have it recognized by MATLAB.

TLC declares Simulink block matrix parameters as scalar or 1-D array variables

real_T scalar; 
real_T mat[ nRows * nCols ];

where real_T can be an arbitrary data type supported by Simulink, and match the variable type
given in the model file.

For example, the 3-by-3 matrix in the Look-Up Table (2-D) block

1   2   3 
4   5   6 
7   8   9

is stored in model.rtw as

Parameter {
      Name                "OutputValues"
      Value                Matrix(3,3)
[[1.0, 2.0, 3.0]; [4.0, 5.0, 6.0]; [7.0, 8.0, 9.0];]
   String                "t"
   StringType                "Variable"
   ASTNode {
        IsNonTerminal                      0
       Op                      SL_NOT_INLINED
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        ModelParameterIdx                   3
   }
}

and results in this definition in model.h

typedef struct Parameters_tag {
  real_T s1_Look_Up_Table_2_D_Table[9];
                                /* Variable:s1_Look_Up_Table_2_D_Table
                                  * External Mode Tunable:yes
                                  * Referenced by block:
                                  * <S1>/Look-Up Table (2-D
                         */

  [ ... other parameter definitions ... ]

} Parameters;

The model.h file declares the actual storage for the matrix parameter and you can see that the
format is column-major. That is, read down the columns, then across the rows.

Parameters model_P = {
  /* 3 x 3 matrix s1_Look_Up_Table_2_D_Table */
  { 1.0, 4.0, 7.0, 2.0, 5.0, 8.0, 3.0, 6.0, 9.0 },
  [ ... other parameter declarations ...]
};

TLC accesses matrix parameters via LibBlockMatrixParameter and
LibBlockMatrixParameterAddr, where

LibBlockMatrixParameter(OutputValues, "", "", 0, "", "", 1) returns
"model_P.s1_Look_Up_Table_2_D_Table[nRows]" (automatically optimized from
"[0+nRows*1]") and

LibBlockMatrixParameterAddr(OutputValues, "", "", 0, "", "", 1) returns
"&model_P.s1_Look_Up_Table_2_D_Table[nRows]" for both inlined and noninlined block TLC
code.

Matrix parameters are like other TLC parameters. Only those parameters explicitly accessed by a
TLC library function during code generation are placed in the parameters structure. So, following the
example, s1_Look_Up_Table_2_D_Table is not declared unless LibBlockParameter or
LibBlockParameterAddr explicitly access it.
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See Also

Related Examples
• “Code Generation of Matrices and Arrays”
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model.rtw File and Authoring S-
Functions and Data Objects

• “model.rtw File and Scopes” on page 18-2
• “Data Object Information in model.rtw File” on page 18-5
• “Data References in the model.rtw File” on page 18-9
• “Exception to Using the Library Functions that Access model.rtw” on page 18-11
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model.rtw File and Scopes
The code generation software creates a model.rtw file from your Simulink model. A model.rtw file
is a partial representation of a model generated by the build process for use by the Target Language
Compiler. It describes blocks, inputs, outputs, parameters, states, storage, and other model
components and properties from the corresponding model file.

The generated model.rtw file is input to the Target Language Compiler. If you select Retain .rtw
file from the Configuration Parameters > Code Generation pane, after building a model, you can
view the model.rtw file that was generated.

A model.rtw file is implemented as an ASCII file of parameter-value pairs stored in a hierarchy of
records. A parameter name/parameter value pair is specified as

ParameterName  value

where ParameterName (also called an identifier) is the name of the TLC identifier and value is a
string, scalar, vector, or matrix. For example, in the parameter name/parameter value pair

     NumDataOutputPorts 1    

NumDataOutputPorts is the identifier and 1 is its value.

A record is specified as

RecordName {
     .
     .
     .
}

A record contains parameter name/parameter value pairs and/or subrecords. For example, this record
contains one parameter name/parameter value pair:

DataStores {
    NumDataStores        0
}

Note The structure of the model.rtw file is very likely to change between releases, which is a
compelling reason to limit your access to model.rtw to the library functions documented under TLC
Function Library Reference: “Target Language Compiler”. For additional information, see “Exception
to Using the Library Functions that Access model.rtw” on page 18-11.

Scopes in the model.rtw File
Each record creates a new scope. The model.rtw file uses curly braces { and } to open and close
records (or scopes). Using scopes, you can access values within the model.rtw file.

The scope in this example begins with CompiledModel. Use periods (.) to access values within
particular scopes. The format of model.rtw is

CompiledModel {
  Name   "modelname"           -- Example of a parameter-value
  ...                             pair (record field).
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  System {                     -- There is one system for each
                                  nonvirtual subsystem.
    Block {                    -- Block records for each
      Type     "S-Function"       nonvirtual block in the
                                  system.
      Name     "<S3>/S-Function"
      ...
      Parameter {
       Name "P1"
       Value Matrix(1,2) [[1, 2];]
    }
    ...
    Block {
    }
  }
  ...
  System {                     -- The last system is for the
                                  root of your model.
}

For example, to access Name within CompiledModel, you would use

CompiledModel.Name

Multiple records of the same name form a list where the index of the first record starts at 0. To access
the above S-function block record, you would use

CompiledModel.System[0].Block[0]

To access the name field of this block, you would use

CompiledModel.System[0].Block[0].Name

To simplify this process, you can use the %with directive, which changes the current scope. For
example:

%with CompiledModel.System[0].Block[0]
%assign blockName = Name
%endwith

blockName will have the value "<S3>/S-Function".

When inlining S-function blocks, your S-function block record is scoped as though the above %with
directive was done. In an inlined .tlc file, you should access fields without a fully qualified path.

The following code shows a more detailed scoping example where the Block record has several
parameter-value pairs (Type, Name, Identifier, and so on), and three subrecords, each called
Parameter. Block is a subrecord of System, which is a subrecord of CompiledModel. Note that
the parameter names in this file changes from release to release.

 model.rtw File and Scopes

18-3



See Also

Related Examples
• “Data Object Information in model.rtw File” on page 18-5
• “Data References in the model.rtw File” on page 18-9
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Data Object Information in model.rtw File
You can obtain meta information about the generated code by accessing the model.rtw file in the
build folder.

During the build process, the code generator writes information about Simulink signal and parameter
data objects to the model.rtw file. An Object record with CoderInfo property information is
written for each parameter or signal that meets certain conditions. These conditions are described in
“Object Records for Parameters” on page 18-5 and “Object Records for Signals” on page 18-6.

The Object records contain the information corresponding to the associated data object. To access
Object records, you must write Target Language Compiler code (see “Access Data Object
Information by Using Target Language Compiler (TLC) Code” on page 18-7).

For some data, defining storage classes can be helpful. For more information, see “Finely Control
Data Representation by Writing TLC Code for a Storage Class” on page 38-24. Embedded Coder is
required.

Note These Object record examples are generated from the example model
rtwdemo_configrpinterface. The parameters and signals are individually configured by using the
ExportedGlobal storage class.

Object Records for Parameters
An Object record that has CoderInfo property information is included in the ModelParameters
section of the model.rtw file for each parameter that meets these conditions:

• The parameter resolves to a Simulink.Parameter data object or to a parameter data object that
comes from a class derived from the Simulink.Parameter class.

• The parameter symbol is preserved in the generated code. The symbol is preserved when the
CoderInfo.StorageClass property of the data object is not set to Auto or if you set the
storage class on the individual parameter by using the Code Mappings editors or the
coder.mapping.api.CodeMapping object.

This example shows part of an Object record for a parameter.
ModelParameters {
  NumParameters     10
  ...
    Parameter {
      Identifier          "K1"
      LogicalSrc          P7    
      WorkspaceVarName          "K1"
      Protected              no
      Tunable              yes
      StorageClass          "ExportedGlobal"
      Value              [2]
      OriginalDataTypeIdx     2
      CGTypeIdx              36
      ContainerCGTypeIdx      42
      IsPublic              1
      ReferencedBy          Matrix(1,4)
[[1, 0, 4, 2];]
      GraphicalRef          Matrix(1,2)
[[0, 10];]
      GraphicalSource          [-1, -1]
      OwnerSysIdx          [1, -1]
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      HasObject              1
      Object {
        Package            Simulink
        Class            Parameter
        ObjectProperties {
          Value              2.0
          CoderInfo {
            Object {
            Package              Simulink
            Class              CoderInfo
            ObjectProperties {
              HasCoderInfo        1
              StorageClass        "ExportedGlobal"
              TypeQualifier        ""
              Alias            ""
              Alignment        -1
              IsCSCPackageOverridden    0
              CSCPackageName        "Simulink"
              ParameterOrSignal    "Parameter"
              CustomStorageClass    "Default"
              CustomAttributes {
                Object {
                  Package            SimulinkCSC
                  Class            AttribClass_Simulink_Default
                  ObjectProperties {
             }
         }
          }
         }
        }
       }
  ...
}

Object Records for Signals
An Object record that has CoderInfo property information is included in either the
ExternalOutputs, ExternalInputs, or BlockOutputs section of the model.rtw file for each
signal (including root-level Inport and Outport blocks) whose symbol is preserved in the generated
code. The symbol is preserved when the signal uses a storage class other than Auto and is
individually mapped.

An Object record that has CoderInfo property information is included in the model.rtw file for
each signal that preserves the signal symbol in the generated code and meets these conditions:

• The CoderInfo.StorageClass property of the data object is not set to Auto.
• The data object is individually mapped to a predefined storage class by using the Code Mappings

editor or the coder.mapping.api.CodeMapping object.

If you configure the signal to be an unstructured global variable in the generated code, its validity
and uniqueness are enforced and its symbol is preserved.

This example shows part of an Object record for a root-level Outport block.
ExternalOutputs {
  ...
  NumExternalOutputs        1
  ...
    ExternalOutput {
      ArgSrc              Y0
      Block              [1,3]
      BlockName              "<Root>/Out1"
      GrSrc              [0, 4]
      Identifier          "output"
      StorageClass          "ExportedGlobal"
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      HasObject              1
      Object {
        Package            Simulink
        Class            Signal
        ObjectProperties {
          CoderInfo {
            Object {
              Package              Simulink
              Class              CoderInfo
              ObjectProperties {
                HasCoderInfo        1
                StorageClass        "ExportedGlobal"
                TypeQualifier        ""
                Alias            "output"
                Alignment        -1
                IsCSCPackageOverridden    0
                CSCPackageName        "Simulink"
                ParameterOrSignal    "Signal"
                CustomStorageClass    "Default"
                CustomAttributes {
                  Object {
                    Package            SimulinkCSC
                    Class            AttribClass_Simulink_Default
                    ObjectProperties {
                    }
                  }
                }
              }
            }
          }
  ...
}

Access Data Object Information by Using Target Language Compiler
(TLC) Code
Here, sample code shows how to access data object information from the model.rtw file by using
TLC code.

Access Parameter Object Records

This code fragment iterates over Parameter structures in the ModelParameters section of the
model.rtw file. The code extracts information from parameter Object records.
%with CompiledModel.ModelParameters
  %foreach modelParamIdx = NumParameters
    %assign thisModelParam = Parameter[modelParamIdx]
    %assign paramName = thisModelParam.Identifier
    %if EXISTS("thisModelParam.Object.ObjectProperties")
      %with thisModelParam.Object.ObjectProperties
        %assign valueInObject = Value
        %with CoderInfo.Object.ObjectProperties
          %assign storageClassInObject  = StorageClass
        %endwith
        %% ***********************************
        %% Access user-defined properties here
        %% ***********************************
        %if EXISTS("MY_PROPERTY_NAME")
          %assign userDefinedPropertyName = MY_PROPERTY_NAME
        %endif
        %% ***********************************
      %endwith
    %endif
  %endforeach
%endwith

 Data Object Information in model.rtw File

18-7



Access Signal Object Records

This code fragment iterates over ExternalBlockOutput structures in the BlockOutputs section of
the model.rtw file. The code extracts information from signal Object records.
%with CompiledModel.BlockOutputs
  %foreach blockOutputIdx = NumExternalBlockOutputs
    %assign thisBlockOutput = ExternalBlockOutput[blockOutputIdx]
    %assign signalName = thisBlockOutput.Identifier
    %if EXISTS("thisBlockOutput.Object.ObjectProperties")
      %with thisBlockOutput.Object.ObjectProperties
        %with CoderInfo.Object.ObjectProperties
          %assign storageClassInObject  = StorageClass
        %endwith \
        %% ***********************************\
        %% Access user-defined properties here\
        %% ***********************************
        %if EXISTS("MY_PROPERTY_NAME")
          %assign userDefinedPropertyName = MY_PROPERTY_NAME
        %endif
        %% ***********************************
      %endwith
    %endif
  %endforeach
%endwith

See Also

Related Examples
• “Data References in the model.rtw File” on page 18-9
• “model.rtw File and Scopes” on page 18-2
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Data References in the model.rtw File

Data Reference Overview
Some records in a model.rtw file, such as those corresponding to parameters and constant block
I/O, can have extremely large data value vectors embedded in them. Such a vector can cause
significant memory overhead during code generation because the values must be maintained as text
in memory during this process.

To avoid such overhead, by default the Simulink software does not write out the entire data value
vector into model.rtw. Instead, it writes a key called a data reference that can be used during code
generation to access the data directly from Simulink. If the data is not mutated during code
generation, it is efficiently streamed to disk when the actual code containing the data values is
written out.

A data reference has the format SLData(index), where index is a numeric value that tells Simulink
which data is being referenced. TLC directives such as GENERATE_FORMATTED_VALUE store data
references in unexpanded format in memory. When the generated code is written out to disk, the data
values expand to the actual values.

Control the Data Reference Threshold
By default, Simulink writes a data reference to model.rtw in place of a data vector whose length is
10 or more. To change the maximum length of a vector that can appear literally in the file, use:

set_param(0, 'RTWDataReferencesMinSize', maxlen)

Simulink replaces a vector as long or longer than maxlen with a data reference when it creates
model.rtw. Specify maxlen as an integer or as inf. Specifying inf disables data references. The
complete value set of every vector, however long, then appears literally in model.rtw and occupies
text memory during code generation.

Setting an explicit maxlen affects only the current MATLAB session. To set the value across sessions,
include a set_param command in your startup.m file, or automate execution of the command when
MATLAB launches.

Expand Data References
You can explicitly expand a data reference by using the GENERATE_FORMATTED_VALUE built-in
function with the optional third expand argument. Commands such as FEVAL may cause a data
reference to be expanded to the full form.

Avoid Data Reference Expansion
Either turning off data references completely or expanding select parameters in TLC can cause
significant text memory overhead during the code generation process. During most common code
generation tasks, it is unnecessary to have the expanded data vector in memory and pay the price of
the additional overhead. Avoid expanded data vectors unless no alternative exists.
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Restart Code Generation
A model.rtw file that contains data references cannot be used in isolation to restart a custom code
generation process. The data references within it become stale once the code generation process is
completed. Attempting to start a code generation process using only this file may result in
unpredictable behavior and memory segmentation faults.

See Also

Related Examples
• “Data Object Information in model.rtw File” on page 18-5
• “Exception to Using the Library Functions that Access model.rtw” on page 18-11
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Exception to Using the Library Functions that Access
model.rtw

There are several library functions that provide access to block inputs, outputs, parameters, sample
times, and other information. It is recommended that you use these library functions to access many
of the parameter name/parameter values pairs in the block record, as opposed to accessing the
parameter name/parameter value pairs directly from your block TLC code. For more information
about using these functions (recommended method for accessing model.rtw), see “Target Language
Compiler Library Functions Overview” on page 22-2.

An exception to using these functions is when you access parameter settings for a block. Parameter
settings can be written out using the mdlRTW function of a C MEX S-function. They can contain data
in the form of strings, scalar values, vectors, and matrices. They can be used to pass fixed values and
information that is used to alter the generated code for a block or directly as values in the resulting
code of a block.

Example Exception to Using the Library Functions
The following example demonstrates accessing parameter settings for a block using the mdlRTW
function of a C MEX S-function. For more details on using parameter settings, see “Inlining S-
Functions” on page 15-8.

mdlRTW Function in C MEX S-Function Code
static void mdlRTW(SimStruct *S)
{
    if (!ssWriteRTWParamSettings( S, 1, SSWRITE_VALUE_QSTR, "Operator", "AND"))
    {
        ssSetErrorStatus(S,"Error writing parameter data to .rtw file");
        return;
    }
}

Resulting Block Record in model.rtw File
Block {
      Type    "S-Function"
      Name    "<Root>/S-Function"

      ...

      SFcnParamSettings {
        Operator    "AND"
      }
    }

TLC Code to Access the Parameter Settings
%function Outputs(block, system) Output
  %%
  %% Select Operator
  %switch(SFcnParamSettings.Operator)
    %case "AND"
      %assign LogicOp        = "&"
      %break
    ...
  %endswitch
%endfunction
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Caution Against Directly Accessing Record Fields
When functions in the block target file are called, they are passed to the block and system records for
this instance as arguments. The first argument, block, is in scope, which means that variable names
inside this instance’s block record are accessible by name. For example:

%assign fast = SFcnParamSetting.Fast

Block target files could generate code for a given block by directly using the fields in the Block record
for the block. This process is not recommended, for two reasons:

• The contents of the model.rtw file can change from release to release. This can cause block TLC
files that access the model.rtw file directly to stop working.

• TLC library functions are provided that substantially reduce the amount of TLC code for
implementing a block while handling the various configurations (widths, data types, etc.) a block
might have. These library functions are provided by the system target files to provide access to
inputs, outputs, parameters, and so on. Using these functions in a block TLC script makes it
flexible enough to generate code for multiple instances or configurations of the block, as well as
across releases. Exceptions to this do occur, however, such as when you want to directly access a
field in the block’s record. This happens with parameter settings, as discussed in “TLC Code to
Access the Parameter Settings” on page 18-11.

See Also

Related Examples
• “Access Memory in Generated Code Using Global Data Map”
• “Data References in the model.rtw File” on page 18-9
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Directives and Built-In Functions

You control how code is generated from models largely through writing or modifying scripts that
apply TLC directives and built-in functions. Use the following sections as your primary reference to
the syntax and format of target language constructs, as well as the MATLAB tlc command itself.

• “Target Language Compiler Directives” on page 19-2
• “Command-Line Arguments” on page 19-48
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Target Language Compiler Directives
You control how code is generated from models largely through writing or modifying scripts that
apply TLC directives and built-in functions. Use the following sections as your primary reference to
the syntax and format of target language constructs, as well as the MATLAB tlc command itself.

A target language directive must be the first non-blank character on a line and begins with the %
character. Lines beginning with %% are TLC comments, and are not passed to the output stream.
Lines beginning with /* are C comments, and are passed to the output stream.

Syntax
A target language file consists of a series of statements of either form:

• [text | %<expression>]* 

The literal text is passed to the output stream unmodified, and expressions enclosed in %< > are
evaluated before being written to output (stripped of %< >).

• %keyword [argument1, argument2, ...]

The %keyword represents one of the directives of Target Language Compiler, and [argument1,
argument2, ...] represents expressions that define required parameters. For example, the
statement

%assign sysNumber = sysIdx + 1

uses the %assign directive to define or change the value of the sysNumber parameter.

Directives
The rest of this section shows the complete set of Target Language Compiler directives, and
describes each directive in detail.

%% text

Single-line comment where text is the comment.

/% text%/

Single (or multiline) comment where text is the comment.

%matlab

Calls a MATLAB function that does not return a result. For example, %matlab disp(2.718).

%<expr>

Target language expressions that are evaluated. For example, if you have a TLC variable that was
created via %assign varName = "foo", then %<varName> would expand to foo. Expressions can
also be function calls, as in %<FcnName(param1,param2)>. On directive lines, TLC expressions
need not be placed within the %<> syntax. Doing so causes a double evaluation. For example, %if
%<x> == 3 is processed by creating a hidden variable for the evaluated value of the variable x. The
%if statement then evaluates this hidden variable and compares it against 3. The efficient way to do
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this operation is to write %if x == 3. In MATLAB notation, this would equate to writing if
eval('x') == 3 as opposed to if x = 3. The exception to this is during an %assign for format
control, as in

 %assign str = "value is: %<var>"

Note: Nested evaluation expressions (e.g., %<foo(%<expr>)> ) are not supported.

There is not a speed penalty for evaluations inside strings, such as

%assign x = "%<expr>"

Avoid evaluations outside strings, such as the following example.

%assign x = %<expr>

%if expr%elseif expr%else%endif

Conditional inclusion, where the constant expression expr must evaluate to an integer. For example,
the following code checks whether a parameter, k, has the numeric value 0.0 by executing a TLC
library function to check for equality.

%if ISEQUAL(k, 0.0)
  <text and directives to be processed if k is 0.0>
%endif

In this and other directives, you do not have to expand variables or expressions using the %<expr>
notation unless expr appears within a string. For example,

%if ISEQUAL(idx, "my_idx%<i>"), where idx and i are both strings.

As in other languages, logical evaluations do short-circuit (are halted when the result is known).

%switch expr   %case expr   %break   %default   %break %endswitch

The %switch directive is similar to the C language switch statement. The expression expr should
be of a type that can be compared for equality using the == operator. If the %break is not
included after a %case statement, then it will fall through to the next statement.

%with %endwith

%with recordName is a scoping operator. Use it to bring the named record into the current scope,
to remain until the matching %endwith is encountered (%with directives can be nested as desired).

Note that on the left side of %assign statements contained within a %with / %endwith block,
references to fields of records must be fully qualified (see “Assign Values to Fields of Records” on
page 17-8), as in the following example.

%with CompiledModel
     %assign oldName = name
     %assign CompiledModel.name = "newname"
     %endwith

%setcommandswitch string

Changes the value of a command-line switch as specified by the argument string. Only the following
switches are supported:

 Target Language Compiler Directives

19-3



v, m, p, O, d, r, I, a

The following example sets the verbosity level to 1.

%setcommandswitch "-v1"

See also “Command-Line Arguments” on page 19-48.

%assert expr

Tests a value of a Boolean expression. If the expression evaluates to false, TLC issues an error
message, a stack trace and exit; otherwise, the execution continues normally. To enable the
evaluation of assertions outside the code generator environment, use the command-line option -da.
When building from within the code generator, this flag is ignored, as it is superseded by the Enable
TLC assertion check box on the TLC process section of the Code Generation > Debug pane. To
control assertion handling from the MATLAB Command Window, use

set_param(model, 'TLCAssertion', 'on|off')

to set this flag on or off. Default is Off. To see the current setting, use

get_param(model, 'TLCAssertion')

%error %warning %trace %exit

Flow control directives:

%error tokens
The tokens are expanded and displayed.

%warning tokens
The tokens are expanded and displayed.

%trace tokens
The tokens are expanded and displayed only when the verbose output command-line option -v
or -v1 is specified.

%exit tokens
The tokens are expanded, displayed, and TLC exits.

When reporting errors, use the following command if the error is produced by an incorrect
configuration that the user needs to fix in the model.

%exit Error Message

If you are adding assert code (that is, code that should never be reached), use

%setcommandswitch "-v1" %% force TLC stack trace 
%exit Assert message

%assign

Creates identifiers (variables). The general form is

%assign [::]variable = expression 

The :: specifies that the variable being created is a global variable; otherwise, it is a local variable in
the current scope (i.e., a local variable in the function).
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If you need to format the variable, say, within a string based upon other TLC variables, then you
should perform a double evaluation, as in

%assign nameInfo = "The name of this is %<Name>"

or alternately

%assign nameInfo = "The name of this is " + Name

To assign a value to a field of a record, you must use a qualified variable expression. See “Assign
Values to Fields of Records” on page 17-8.

%createrecord

Creates records in memory. This command accepts a list of one or more record specifications (e.g.,
{ foo 27 }). Each record specification contains a list of zero or more name-value pairs (e.g., foo
27) that become the members of the record being created. The values themselves can be record
specifications, as the following illustrates.
%createrecord NEW_RECORD { foo 1 ; SUB_RECORD {foo 2} }
%assign x = NEW_RECORD.foo                  /* x = 1 */
%assign y = NEW_RECORD.SUB_RECORD.foo       /* y = 2 */

If more than one record specification follows a given record name, the set of record specifications
constitutes an array of records.
%createrecord RECORD_ARRAY { foo 1 } ...
                                    { foo 2 } ...
                                    { bar 3 } 
%assign x = RECORD_ARRAY[1].foo             /* x = 2 */
%assign y = RECORD_ARRAY[2].bar             /* y = 3 */

Note that you can create and index arrays of subrecords by specifying %createrecord with
identically named subrecords, as follows:
%createrecord RECORD_ARRAY { SUB_RECORD { foo 1 } ... 
                             SUB_RECORD { foo 2 } ... 
                             SUB_RECORD { foo 3 } }
%assign x = RECORD_ARRAY.SUB_RECORD[1].foo  /* x = 2 */
%assign y = RECORD_ARRAY.SUB_RECORD[2].foo  /* y = 3 */

If the scope resolution operator (::) is the first token after the %createrecord token, the record is
created in the global scope.

Note You should not create a record array by using %createrecord within a loop.

%addtorecord

Adds fields to an existing record. The new fields can be name-value pairs or aliases to already existing
records.

%addtorecord OLD_RECORD foo 1

If the new field being added is a record, then %addtorecord makes an alias to that record instead of
a deep copy. To make a deep copy, use %copyrecord.

%createrecord NEW_RECORD { foo 1 }
%addtorecord OLD_RECORD NEW_RECORD_ALIAS NEW_RECORD
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%mergerecord

Adds (or merges) one or more records into another. The first record will contain the results of the
merge of the first record plus the contents of the other records specified by the command. The
contents of the second (and subsequent) records are deep copied into the first (i.e., they are not
references).

%mergerecord OLD_RECORD NEW_RECORD

If duplicate fields exist in the records being merged, the original record’s fields are not overwritten.

%copyrecord

Makes a deep copy of an existing record. It creates a new record in a similar fashion to
%createrecord except the components of the record are deep copied from the existing record.
Aliases are replaced by copies.

%copyrecord NEW_RECORD OLD_RECORD

%realformat

Specifies how to format real variables. To format in exponential notation with 16 digits of precision,
use

%realformat "EXPONENTIAL"

To format without loss of precision and minimal number of characters, use

%realformat "CONCISE"

When inlining S-functions, the format is set to concise. You can switch to exponential, but should
switch it back to concise when done.

%language

This must appear before the first GENERATE or GENERATE_TYPE function call. This specifies the name
of the language as a string, which is being generated as in %language "C". Generally, this is added
to your system target file.

The only valid value is C which enables support for C and C++ code generation as specified by the
configuration parameter TargetLang (see “Language” for more information).

%implements

Placed within the .tlc file for a specific record type, when mapped via %generatefile. The syntax
is %implements "Type" "Language". When inlining an S-function in C or C++, this should be the
first noncomment line in the file, as in

%implements "s_function_name" "C"

The next noncomment lines will be %function directives specifying the functionality of the S-
function.

See the %language and GENERATE function descriptions for further information.
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%generatefile

Provides a mapping between a record Type and functions contained in a file. Each record can have
functions of the same name but different contents mapped to it (i.e., polymorphism). Generally, this is
used to map a Block record Type to the .tlc file that implements the functionality of the block, as
in

%generatefile "Sin" "sin_wave.tlc"

%filescope

Limits the scope of variables to the file in which they are defined. A %filescope directive anywhere
in a file declares that variables in the file are visible only within that file. Note that this limitation also
applies to files inserted, via the %include directive, into the file containing the %filescope
directive.

You should not use the %filescope directive within functions or GENERATE functions.

%filescope is useful in conserving memory. Variables whose scope is limited by %filescope go out
of scope when execution of the file containing them completes. This frees memory allocated to such
variables. By contrast, global variables persist in memory throughout execution of the program.

%include

Use %include "file.tlc"to insert the specified target file at the current point.

The %include directives behave as if they were in a global context. For example,

%addincludepath "./sub1"
%addincludepath "./sub2"

in a .tlc file enables either subfolder to be referenced implicitly:

%include "file_in_sub1.tlc"
%include "file_in_sub2.tlc"

Use forward slashes for folder names, as they work on both UNIX and PC systems. However, if you do
use back slashes in PC folder names, be sure to escape them, e.g., "C:\\mytlc". Alternatively, you
can express a PC folder name as a literal using the L format specifier, as in L"C:\mytlc".

%addincludepath

Use %addincludepath "folder" to add additional paths to be searched. Multiple
%addincludepath directives can appear. The compiler evaluates multiple %addincludepath
directives from the bottom up.

Using %addincludepath directives establishes a global context. For example,

%addincludepath "./sub1"
%addincludepath "./sub2"

in a .tlc file enables either subfolder to be referenced implicitly:

%include "file_in_sub1.tlc"
%include "file_in_sub2.tlc"
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Use forward slashes for folder names, as they work on both UNIX and PC systems. However, if you do
use back slashes in PC folder names, be sure to escape them, e.g., "C:\\mytlc". Alternatively, you
can express a PC folder name as a literal using the L format specifier, as in L"C:\mytlc".

%roll %endroll

Multiple inclusion plus intrinsic loop rolling based upon a specified threshold. This directive can be
used by most Simulink blocks that have the concept of an overall block width that is usually the width
of the signal passing through the block.

This example of the %roll directive is for a gain operation, y=u*k:
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %assign rollVars = ["U", "Y", "P"]
  %roll sigIdx = RollRegions, lcv = RollThreshold, block,... 
        "Roller", rollVars
    %assign y = LibBlockOutputSignal(0, "", lcv, sigIdx)
    %assign u = LibBlockInputSignal(0, "", lcv, sigIdx)
    %assign k = LibBlockParameter(Gain, "", lcv, sigIdx)
      %<y> = %<u> * %<k>;
  %endroll
%endfunction

The %roll directive is similar to %foreach, except that it iterates the identifier (sigIdx in this
example) over roll regions. Roll regions are computed by looking at the input signals and generating
regions where the inputs are contiguous. For blocks, the variable RollRegions is automatically
computed and placed in the Block record. An example of a roll regions vector is [0:19, 20:39],
where there are two contiguous ranges of signals passing through the block. The first is 0:19 and the
second is 20:39. Each roll region is either placed in a loop body (e.g., the C language for
statement) or inlined, depending upon whether or not the length of the region is less than the roll
threshold.

Each time through the %roll loop, sigIdx is an integer for the start of the current roll region or an
offset relative to the overall block width when the current roll region is less than the roll threshold.
The TLC global variable RollThreshold is the general model-wide value used to decide when to
place a given roll region in a loop. When the decision is made to place a given region in a loop, the
loop control variable is a valid identifier (e.g., "i"); otherwise it is "".

The block parameter is the current block that is being rolled. The "Roller" parameter specifies the
name for internal GENERATE_TYPE calls made by %roll. The default %roll handler is "Roller",
which is responsible for setting up the default block loop rolling structures (e.g., a C for loop).

The rollVars (roll variables) are passed to "Roller" functions to create roll structures. The
defined loop variables relative to a block are

"U"
The inputs to the block. It assumes you use LibBlockInputSignal(portIdx, "", lcv,
sigIdx) to access each input, where portIdx starts at 0 for the first input port.

"ui"
Similar to "U", except only for specific input, i. The "u" must be lowercase or it will be
interpreted as "U" above.

"Y"
The outputs of the block. It assumes you use LibBlockOutputSignal(portIdx, "", lcv,
sigIdx) to access each output, where portIdx starts at 0 for the first output port.
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"yi"
Similar to "Y", except only for specific output, i. The "y" must be lowercase or it will be
interpreted as "Y" above.

"P"
The parameters of the block. It assumes you use LibBlockParameter(name, "", lcv,
sigIdx) to access them.

"<param>/name"
Similar to "P", except specific for a specific name.

rwork
The RWork vectors of the block. It assumes you use LibBlockRWork(name, "", lcv,
sigIdx) to access them.

"<rwork>/name"
Similar to RWork, except for a specific name.

dwork
The DWork vectors of the block. It assumes you use LibBlockDWork(name, "", lcv,
sigIdx) to access them.

"<dwork>/name"
Similar to DWork, except for a specific name.

iwork
The IWork vectors of the block. It assumes you use LibBlockIWork(name, "", lcv,
sigIdx) to access them.

"<iwork>/name"
Similar to IWork, except for a specific name.

pwork
The PWork vectors of the block. It assumes you use LibBlockPWork(name, "", lcv,
sigIdx) to access them.

"<pwork>/name"
Similar to PWork, except for a specific name.

"Mode"
The mode vector. It assumes you use LibBlockMode("",lcv,sigIdx) to access it.

"PZC"
Previous zero-crossing state. It assumes you use LibPrevZCState("",lcv, sigIdx) to access
it.

To roll your own vector based upon the block’s roll regions, you need to walk a pointer to your vector.
Assuming your vector is pointed to by the first PWork, called name,
datatype *buf = (datatype*)%<LibBlockPWork(name,"","",0)
%roll sigIdx = RollRegions, lcv = RollThreshold, block, ...
      "Roller", rollVars
  *buf++ = whatever;
%endroll

Note: In the above example, sigIdx and lcv are local to the body of the loop.
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%breakpoint

Sets a breakpoint for the TLC debugger. See “%breakpoint Directive” on page 20-5.

%function %return %endfunction

A function that returns a value is defined as

%function name(optional-arguments) 
    %return value 
  %endfunction

A void function does not produce output and is not required to return a value. It is defined as

%function name(optional-arguments) void 
  %endfunction

A function that produces outputs to the current stream and is not required to return a value is
defined as

%function name(optional-arguments) Output 
  %endfunction

For block target files, you can add to your inlined .tlc file the following functions that are called by
the model-wide target files during code generation.

%function BlockInstanceSetup(block,system) void
Called for each instance of the block within the model.

%function BlockTypeSetup(block,system) void
Called once for each block type that exists in the model.

%function Enable(block,system) Output
Use this if the block is placed within an enabled subsystem and has to take specific actions when
the subsystem is enabled. Place within a subsystem enable routine.

%function Disable(block,system) Output
Use this if the block is placed within a disabled subsystem and has to take specific actions when
the subsystem is disabled. Place within a subsystem disable routine.

%function Start(block,system) Output
Include this function if your block has startup initialization code that needs to be placed within
MdlStart.

%function InitializeConditions(block,system) Output
Use this function if your block has state that needs to be initialized at the start of execution and
when an enabled subsystem resets states. Place in MdlStart and/or subsystem initialization
routines.

%function Outputs(block,system) Output
The primary function of your block. Place in MdlOutputs.

%function Update(block,system) Output
Use this function if your block has actions to be performed once per simulation loop, such as
updating discrete states. Place in MdlUpdate.

%function Derivatives(block,system) Output
Use this function if your block has derivatives.
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%function ZeroCrossings(block,system) Output
Use this function if your block does zero-crossing detection and has actions to be performed in
MdlZeroCrossings.

%function Terminate(block,system) Output
Use this function if your block has actions that need to be in MdlTerminate.

%foreach %endforeach

Multiple inclusion that iterates from 0 to the upperLimit-1 constant integer expression. Each time
through the loop, the loopIdentifier, (e.g., x) is assigned the current iteration value.

%foreach loopIdentifier = upperLimit 
   %break -- use this to exit the loop 
   %continue -- use this to skip the following code and  
                continue to the next iteration 
%endforeach

Note: The upperLimit expression is cast to a TLC integer value. The loopIdentifier is local to
the loop body.

%for

Multiple inclusion directive with syntax
%for ident1 = const-exp1, const-exp2, ident2 = const-exp3
  %body
    %break
    %continue
  %endbody
%endfor

The first portion of the %for directive is identical to the %foreach statement. The %break and
%continue directives act the same as they do in the %foreach directive. const-exp2 is a Boolean
expression that indicates whether the loop should be rolled (see %roll above).

If const-exp2 evaluates to TRUE, ident2 is assigned the value of const-exp3. Otherwise, ident2
is assigned an empty string.

Note: ident1 and ident2 above are local to the loop body.

%openfile %selectfile %closefile

These are used to manage the files that are created. The syntax is
%openfile streamId="filename.ext" mode  {open for writing} 
%selectfile streamId                    {select an open file} 
%closefile streamId                     {close an open file}

Note that the "filename.ext" is optional. If a filename is not specified, a variable (string buffer)
named streamId is created containing the output. The mode argument is optional. If specified, it can
be "a" for appending or "w" for writing.

Note that the special string streamIdNULL_FILE specifies no output. The special string
streamIdSTDOUT specifies output to the terminal.

To create a buffer of text, use
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%openfile buffer
text to be placed in the 'buffer' variable.
%closefile buffer

Now buffer contains the expanded text specified between the %openfile and %closefile
directives.

%generate

%generate blk fn is equivalent to GENERATE(blk,fn).

%generate blk fn type is equivalent to GENERATE(blk,fn,type).

See “GENERATE and GENERATE_TYPE Functions” on page 19-24.

%undef

%undef var removes the variable var from scope. If var is a field in a record, %undef removes that
field from the record. If var is a record array, %undef removes the entire record array.

Comments
You can place comments anywhere within a target file. To include comments, use the /%...%/ or %%
directives. For example:

/%
    Abstract:    Return the field with [width], if field is wide
%/

or

%endfunction %% Outputs function

Use the %% construct for line-based comments. Characters from %% to the end of the line become a
comment.

Non-directive lines, that is, lines that do not have % as their first non-blank character, are copied into
the output buffer verbatim. For example,

/* Initialize sysNumber */
int sysNumber = 3;

copies both lines to the output buffer.

To include comments on lines that do not begin with the % character, you can use the /%...%/ or %%
comment directives. In these cases, the comments are not copied to the output buffer.

Note If a non-directive line appears within a function, it is not copied to the output buffer unless the
function is an output function or you specifically select an output file using the %selectfile
directive. For more information about functions, see “Target Language Functions” on page 19-45.
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Line Continuation
You can use the C language \ character or the MATLAB sequence ... to continue a line. If a
directive is too long to fit conveniently on one line, this allows you to split the directive onto multiple
lines. For example:

%roll sigIdx = RollRegions, lcv = RollThreshold, block,\ 
      "Roller", rollVars

or

%roll sigIdx = RollRegions, lcv = RollThreshold, block,... 
      "Roller", rollVars

Note Use \ to suppress line feeds to the output and the ellipsis ... to indicate line continuation.
Note that \ and the ellipsis ... cannot be used inside strings.

Target Language Value Types
This table shows the types of values you can use within the context of expressions in your target
language files. Expressions in the Target Language Compiler must use these types.

Value Type String Example Description
"Boolean" 1==1 Result of a comparison or other Boolean operator. The

result will be TLC_TRUE or TLC_FALSE.
"Complex" 3.0+5.0i 64-bit double-precision complex number (double on

the target machine).
"Complex32" 3.0F+5.0Fi 32-bit single-precision complex number (float on the

target machine).
"File" %openfile x String buffer opened with %openfile.
"File" %openfile x = "out.c" File opened with %openfile.
"Function" %function foo... User-defined function and TLC_FALSE otherwise.
"Gaussian" 3+5i 32-bit integer imaginary number (int on the target

machine).
"Identifier" abc Identifier values can appear only within the

model.rtw file and cannot appear in expressions
(within the context of an expression, identifiers are
interpreted as values). To compare against an
identifier value, use a string; the identifier will be
converted to a string.

"Matrix" Matrix (3,2) [ [ 1, 2];
[3 , 4]; [ 5, 6] ]

Matrices are simply lists of vectors. The individual
elements of the matrix do not need to be the same
type, and can be any supported type except vectors or
matrices. The Matrix (3,2) text in the example is
optional.

"Number" 15 Integer number (int on the target machine).
"Range" [1:5] Range of integers between 1 and 5, inclusive.
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Value Type String Example Description
"Real" 3.14159 Floating-point number (double on the target

machine), including exponential notation.
"Real32" 3.14159F 32-bit single-precision floating-point number (float

on the target machine).
"Scope" Block { ... } Block record.
"Special" FILE_EXISTS Special built-in function, such as FILE_EXISTS.
"String" "Hello, World" ASCII character strings. In all contexts, two strings in

a row are concatenated to form the final value, as in
"Hello, " "World", which is combined to form
"Hello, World". These strings include the ANSI C
standard escape sequences such as \n, \r, \t, etc.
Use of line continuation characters (i.e., \ and ...)
inside strings is illegal.

"Subsystem" <sub1> Subsystem identifier. Within the context of an
expansion, be careful to escape the delimiters on a
subsystem identifier, as in %<x == <sub\>>.

"Unsigned" 15U 32-bit unsigned integer (unsigned int on the target
machine).

"Unsigned
Gaussian"

3U+5Ui 32-bit complex unsigned integer (unsigned int on
the target machine).

"Vector" [1, 2] or BR Vector(2)
[1, 2]

Vectors are lists of values. The individual elements of a
vector do not need to be the same type, and can be of
any supported type except vectors or matrices.

Target Language Expressions
You can include an expression of the form %<expression> in a target file. The Target Language
Compiler replaces %<expression> with a calculated replacement value based upon the type of the
variables within the %<> operator. Integer constant expressions are folded and replaced with the
resultant value; string constants are concatenated (e.g., two strings in a row "a" "b", are replaced
with "ab").

%<expression>                /* Evaluates the expression.  
  * Operators include most standard C
  * operations on scalars. Array indexing
  * is required for certain parameters that 
  * are block-scoped within the .rtw file.*/

Within the context of an expression, each identifier must evaluate to an identifier or function
argument currently in scope. You can use the %< > directive on a line to perform text substitution. To
include the > character within a replacement, you must escape it with a \ character. For example:

%<x \> 1 ? "ABC" : "123">

Operators that need the > character to be escaped are the following:
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Operator Description Example
> greater than y = %<x \> 2>;
>= greater than or equal to y = %<x \>= 3>;
>> right shift y = %<x \>\> 4>;

The table Target Language Expressions lists the operators that are allowed in expressions. In this
table, expressions are listed in order from highest to lowest precedence. The horizontal lines
distinguish the order of operations.

As in C expressions, conditional operators are short-circuited. If the expression includes a function
call with effects, the effects are noticed as if the entire expression was not fully evaluated. For
example:

%if EXISTS(foo) && foo == 3

If the first term of the expression evaluates to a Boolean false (i.e., foo does not exist), the second
term (foo == 3) is not evaluated.

In the upcoming table, note that numeric is one of the following:

• Boolean
• Number
• Unsigned
• Real
• Real32
• Complex
• Complex32
• Gaussian
• UnsignedGaussian

Also, note that integral is one of the following:

• Number
• Unsigned
• Boolean

See “TLC Data Promotions” on page 19-18 for information on the promotions that result when the
Target Language Compiler operates on mixed types of expressions.
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Target Language Expressions

Expression Definition
constant Constant parameter value. The value can be a vector or

matrix.
variable-name Valid in-scope variable name, including the local function

scope, if any, and the global scope.
::variable-name Used within a function to indicate that the function scope is

ignored when the variable is looked up. This accesses the
global scope.

expr[expr] Index into an array parameter. Array indices range from 0 to
N-1. This syntax is used to index into vectors, matrices, and
repeated scope variables.

expr([expr[,expr]...]) Function call or macro expansion. The expression outside the
parentheses is the function/macro name; the expressions
inside are the arguments to the function or macro.

Note: Macros are text-based; they cannot be used within the
same expression as other operators.

expr . expr The first expression must have a valid scope; the second
expression is a parameter name within that scope.

(expr) Use () to override the precedence of operations.
!expr Logical negation (generates TLC_TRUE or TLC_FALSE). The

argument must be numeric or Boolean.
-expr Unary minus negates the expression. The argument must be

numeric.
+expr No effect; the operand must be numeric.
~expr Bit-wise negation of the operand. The argument must be an

integer.
expr * expr Multiplies the two expressions; the operands must be

numeric.
expr / expr Divides the two expressions; the operands must be numeric.
expr % expr Takes the integer modulo of the expressions; the operands

must be integers.
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Expression Definition
expr + expr Works on numeric types, strings, vectors, matrices, and

records as follows:

Numeric types: Add the two expressions; the operands must
be numeric.

Strings: The strings are concatenated.

Vectors: If the first argument is a vector and the second is a
scalar, the scalar is appended to the vector.

Matrices: If the first argument is a matrix and the second is a
vector of the same column width as the matrix, the vector is
appended as another row in the matrix.

Records: If the first argument is a record, the second
argument is added as a parameter identifier (with its current
value).

Note that the addition operator is associative.
expr - expr Subtracts the two expressions; the operands must be

numeric.
expr << expr Left-shifts the left operand by an amount equal to the right

operand; the arguments must be integers.
expr >> expr Right-shifts the left operand by an amount equal to the right

operand; the arguments must be integers.
expr > expr Tests whether the first expression is greater than the second

expression; the arguments must be numeric.
expr < expr Tests whether the first expression is less than the second

expression; the arguments must be numeric.
expr >= expr Tests whether the first expression is greater than or equal to

the second expression; the arguments must be numeric.
expr <= expr Tests whether the first expression is less than or equal to the

second expression; the arguments must be numeric.
expr == expr Tests whether the two expressions are equal.
expr != expr Tests whether the two expressions are not equal.
expr & expr Performs the bit-wise AND of the two arguments; the

arguments must be integers.
expr ^ expr Performs the bit-wise XOR of the two arguments; the

arguments must be integers.
expr | expr Performs the bit-wise OR of the two arguments; the

arguments must be integers.
expr && expr Performs the logical AND of the two arguments and returns

TLC_TRUE or TLC_FALSE. This can be used on either numeric
or Boolean arguments.
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Expression Definition
expr || expr Performs the logical OR of the two arguments and returns

TLC_TRUE or TLC_FALSE. This can be used on either numeric
or Boolean arguments.

expr ? expr : expr Tests the first expression for TLC_TRUE. If true, the first
expression is returned; otherwise, the second expression is
returned.

expr , expr Returns the value of the second expression.

Note Relational operators ( <, =<, >, >=, !=, == ) can be used with nonfinite values.

You do not have to place expressions in the %< > eval format when they appear on directive lines.
Doing so causes a double evaluation.

TLC Data Promotions

When the Target Language Compiler operates on mixed types of expressions, it promotes the results
to the common types indicated in the following table.

The table uses the following abbreviations:

B Boolean
N Number
U Unsigned
F Real32
D Real
G Gaussian
UG UnsignedGaussian
C32 Complex32
C Complex

The top row (in bold) and first column (in bold) show the types of expression used in the operation.
The intersection of the row and column shows the resulting type of expressions.

For example, if the operation involves a Boolean expression (B) and an unsigned expression (U), the
result will be an unsigned expression (U).
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Data Types Resulting from Expressions of Mixed Type
 B N U F D G UG C32 C
B B N U F D G UG C32 C
N N N U F D G UG C32 C
U U U U F D UG UG C32 C
F F F F F D C32 C32 C32 C
D D D D D D C C C C
G G G UG C32 C G UG C32 C
UG UG UG UG C32 C UG UG C32 C
C32 C32 C32 C32 C32 C C32 C32 C32 C
C C C C C C C C C C

Formatting
By default, the Target Language Compiler outputs floating-point numbers in exponential notation
with 16 digits of precision. To override the default, use the directive

%realformat string

If string is "EXPONENTIAL", the standard exponential notation with 16 digits of precision is used. If
string is "CONCISE", the compiler uses internal heuristics to output the values in a more readable
form while maintaining accuracy. The %realformat directive sets the default format for Real
number output to the selected style for the remainder of processing or until it encounters another
%realformat directive.

Conditional Inclusion
The conditional inclusion directives are

%if constant-expression
%else
%elseif constant-expression
%endif

%switch constant-expression
%case constant-expression
%break
%default
%endswitch

%if

The constant-expression must evaluate to an integer expression. It controls the inclusion of the
following lines until it encounters an %else, %elseif, or %endif directive. If the constant-
expression evaluates to 0, the lines following the directive are not included. If the constant-
expression evaluates to an integer value other than 0, the lines following the %if directive are
included until the %endif, %elseif, or %else directive.

When the compiler encounters an %elseif directive, and no prior %if or %elseif directive has
evaluated to nonzero, the compiler evaluates the expression. If the value is 0, the lines following the
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%elseif directive are not included. If the value is nonzero, the lines following the %elseif directive
are included until the subsequent %else, %elseif, or %endif directive.

The %else directive begins the inclusion of source text if the previous %elseif statements or the
original %if statement evaluates to 0; otherwise, it prevents the inclusion of subsequent lines up to
and including the following %endif.

The constant-expression can contain any expression specified in “Target Language Expressions”
on page 19-14.

%switch

The %switch statement evaluates the constant expression and compares it to expressions appearing
on %case selectors. If a match is found, the body of the %case is included; otherwise the %default
is included.

%case ... %default bodies flow together, as in C, and %break must be used to exit the switch
statement. %break exits the nearest enclosing %switch, %foreach, or %for loop in which it
appears. For example,

%switch(type)
%case x         
    /* Matches variable x. */
    /* Note: Any valid TLC type is allowed. */
%case "Sin"
    /* Matches Sin or falls through from case x. */
   %break
    /* Exits the switch. */
%case "gain"
    /* Matches gain. */
   %break
%default
    /* Does not match x, "Sin," or "gain." */
%endswitch

In general, this is a more readable form for the %if/%elseif/%else construction.

Multiple Inclusion
%foreach

The syntax of the %foreach multiple inclusion directive is

%foreach identifier = constant-expression
   %break
   %continue
%endforeach

The constant-expression must evaluate to an integer expression, which then determines the
number of times to execute the foreach loop. The identifier increments from 0 to one less than
the specified number. Within the foreach loop, you can use x, where x is the identifier, to access the
identifier variable. %break and %continue are optional directives that you can include in the
%foreach directive:

• Use %break to exit the nearest enclosing %for, %foreach, or %switch statement.
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• Use %continue to begin the next iteration of a loop.

%for

Note The %for directive is functional, but it is not recommended. Instead, use %roll, which
provides the same capability in a more open way. The code generator does not use the %for
construct.

The syntax of the %for multiple inclusion directive is

%for ident1 = const-exp1, const-exp2, ident2 = const-exp3
  %body
    %break
    %continue
  %endbody
%endfor

The first portion of the %for directive is identical to the %foreach statement in that it causes a loop
to execute from 0 to N-1 times over the body of the loop. In the normal case, it includes only the lines
between %body and %endbody, and the lines between the %for and %body, and ignores the lines
between %endbody and %endfor.

The %break and %continue directives act the same as they do in the %foreach directive.

const-exp2 is a Boolean expression that indicates whether the loop should be rolled. If const-
exp2 is true, ident2 receives the value of const-exp3; otherwise it receives the null string. When
the loop is rolled, the lines between the %for and the %endfor are included in the output exactly one
time. ident2 specifies the identifier to be used for testing whether the loop was rolled within the
body. For example,

%for Index = <NumNonVirtualSubsystems>3, rollvar="i"

    {
        int i;

        for (i=0; i< %<NumNonVirtualSubsystems>; i++)
        {
          %body
    x[%<rollvar>] = system_name[%<rollvar>];
          %endbody

        }
    }
%endfor

If the number of nonvirtual subsystems (NumNonVirtualSubsystems) is greater than or equal to 3,
the loop is rolled, causing the code within the loop to be generated exactly once. In this case, Index
= 0.

If the loop is not rolled, the text before and after the body of the loop is ignored and the body is
generated NumNonVirtualSubsystems times.

This mechanism gives each individual loop control over whether or not it should be rolled.
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%roll

The syntax of the %roll multiple inclusion directive is

%roll ident1 = roll-vector-exp, ident2 = threshold-exp, ... 
               block-exp [, type-string [,exp-list] ]
  %break
  %continue
%endroll

This statement uses the roll-vector-exp to expand the body of the %roll statement multiple
times as in the %foreach statement. If a range is provided in the roll-vector-expand that range
is larger than the threshold-exp expression, the loop will roll. When a loop rolls, the body of the
loop is expanded once and the identifier (ident2) provided for the threshold expression is set to the
name of the loop control variable. If no range is larger than the specified rolling threshold, this
statement is identical to the %foreach statement. For example,

%roll Idx = [ 1 2 3:5, 6, 7:10 ], lcv = 10, ablock
%endroll

In this case, the body of the %roll statement expands 10 times, as in the %foreach statement,
because there are no regions greater than or equal to 10. Idx counts from 1 to 10, and lcv is set to
the null string, "".

When the Target Language Compiler determines that a given block will roll, it performs a
GENERATE_TYPE function call to output the various pieces of the loop (other than the body). The
default type used is Roller; you can override this type with a string that you specify. Extra
arguments passed to the %roll statement are provided as arguments to these special-purpose
functions. The called function is one of these four functions:

RollHeader(block, ...)

This function is called once on the first section of this roll vector that will actually roll. It should
return a string that is assigned to the lcv within the body of the %roll statement.

LoopHeader(block, StartIdx, Niterations, Nrolled, ...)

This function is called once for each section that will roll prior to the body of the %roll statement.

LoopTrailer(block, Startidx, Niterations, Nrolled, ...)

This function is called once for each section that will roll after the body of the %roll statement.

RollTrailer(block, ...)

This function is called once at the end of the %roll statement if any of the ranges caused loop
rolling.

These functions should output language-specific declarations, loop code, and so on as required to
generate code for the loop.

An example of a Roller.tlc file is

%implements Roller "C"
%function RollHeader(block) Output
    {
        int i;
    %return ("i")
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%endfunction
%function LoopHeader(block,StartIdx,Niterations,Nrolled) Output
     for (i = %<StartIdx>; i < %<Niterations+StartIdx>; i++)
    {
%endfunction
%function LoopTrailer(block,StartIdx,Niterations,Nrolled) Output
    }
%endfunction
%function RollTrailer(block) Output
    }
%endfunction

Note The Target Language Compiler function library provided with the code generator has the
capability to extract references to the block I/O and other code generator vectors that vastly simplify
the body of the %roll statement. These functions include LibBlockInputSignal,
LibBlockOutputSignal, LibBlockParameter, LibBlockRWork, LibBlockIWork,
LibBlockPWork, LibDeclareRollVars, LibBlockMatrixParameter,
LibBlockParameterAddr, LibBlockContinuousState, and LibBlockDiscreteState. (See the
function reference pages in “Input Signal Functions” on page 22-7, “Output Signal Functions” on
page 22-17, “Parameter Functions” on page 22-23, and “Block State and Work Vector Functions”
on page 22-28.) This library also includes a default implementation of Roller.tlc as a “flat” roller.

Extending the former example to a loop that rolls,

%language "C"
%assign ablock = BLOCK { Name "Hi" }
%roll Idx = [ 1:20, 21, 22, 23:25, 26:46], lcv = 10, ablock
    Block[%< lcv == "" ? Idx : lcv>] *= 3.0;
%endroll

This Target Language Compiler code produces this output:

{
    int             i;
    for (i = 1; i < 21; i++)
    {
        Block[i] *= 3.0;
    }
    Block[21] *= 3.0;
    Block[22] *= 3.0;
    Block[23] *= 3.0;
    Block[24] *= 3.0;
    Block[25] *= 3.0;
    for (i = 26; i < 47; i++)
    {
        Block[i] *= 3.0;
    }
}

Object-Oriented Facility for Generating Target Code
The Target Language Compiler provides a simple object-oriented facility. The language directives are
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%language string
%generatefile
%implements

This facility was designed specifically for customizing the code for Simulink blocks, but can be used
for other purposes as well.

%language

The %language directive specifies the target language being generated. It is required as a
consistency check to verify the implementation files found for the language being generated. The
%language directive must appear prior to the first GENERATE or GENERATE_TYPE built-in function
call. %language specifies the language as a string. For example:

%language "C"

Simulink blocks have a Type parameter. This parameter is a string that specifies the type of the
block, for example "Sin" or "Gain". The object-oriented facility uses this type to search the path for
a file that implements the block. By default the name of the file is the Type of the block with .tlc
appended, so for example, if the Type is "Sin" the Compiler would search for "Sin.tlc" along the
path. You can override this default filename using the %generatefile directive to specify the
filename that you want to use to replace the default filename. For example,

%generatefile "Sin" "sin_wave.tlc"

The files that implement the block-specific code must contain an %implements directive indicating
both the type and the language being implemented. The Target Language Compiler will produce an
error if the %implements directive does not match as expected. For example,

%implements "Sin" "Pascal"

causes an error if the initial language choice was C.

You can use a single file to implement more than one target language by specifying the desired
languages in a vector. For example,

%implements "Sin" "C"

Finally, you can implement several types using the wildcard (*) for the type field:

%implements * "C"

Note The use of the wildcard (*) is not recommended because it relaxes error checking for the
%implements directive.

GENERATE and GENERATE_TYPE Functions

The Target Language Compiler has two built-in functions that dispatch object-oriented calls,
GENERATE and GENERATE_TYPE. You can call a function appearing in an implementation file (from
outside the specified file) only by using the GENERATE and GENERATE_TYPE special functions.

GENERATE

The GENERATE function takes two or more input arguments. The first argument must be a valid scope
and the second a string containing the name of the function to call. The GENERATE function passes
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the first block argument and any additional arguments specified to the function being called. The
return argument is the value, if any, returned from the function being called. Note that the compiler
automatically “scopes” or adds the first argument to the list of scopes searched as if it appears on a
%with directive line. (See “Variable Scoping” on page 19-38.) This scope is removed when the
function returns.

GENERATE_TYPE

The GENERATE_TYPE function takes three or more input arguments. It handles the first two
arguments identically to the GENERATE function call. The third argument is the type; the type
specified in the Simulink block is ignored. This facility is used to handle S-function code generation
by the build process. That is, the block type is S-function, but the Target Language Compiler
generates it as the specific S-function specified by GENERATE_TYPE. For example,

GENERATE_TYPE(block, "Output", "dp_read")

specifies that S-function block is of type dp_read.

The block argument and any additional arguments are passed to the function being called. Like the
GENERATE built-in function, the compiler automatically scopes the first argument before the
GENERATE_TYPE function is entered and then removes the scope on return.

Within the file containing %implements, function calls are looked up first within the file and then in
the global scope. This makes it possible to have hidden helper functions used exclusively by the
current object.

Note It is not an error for the GENERATE and GENERATE_TYPE directives to find no matching
functions. This is to prevent requiring empty specifications for all aspects of block code generation.
Use the GENERATE_FUNCTION_EXISTS or GENERATE_TYPE_FUNCTION_EXISTS directives to
determine whether the specified function actually exists.

Output File Control
The structure of the output file control construct is

%openfile string optional-equal-string optional-mode
%closefile id
%selectfile id

%openfile

The %openfile directive opens a file or buffer for writing; the required string variable becomes a
variable of type file. For example,

%openfile x               /% Opens and selects x for writing. %/
%openfile out = "out.h"   /% Opens "out.h" for writing. %/

%selectfile

The %selectfile directive selects the file specified by the variable as the current output stream.
Output goes to that file until another file is selected using %selectfile. For example,

%selectfile x               /% Select file x for output. %/
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%closefile

The %closefile directive closes the specified file or buffer. If the closed entity is the currently
selected output stream, %closefile invokes %selectfile to reselect the previously selected
output stream.

There are two possible cases that %closefile must handle:

• If the stream is a file, the associated variable is removed as if by %undef.
• If the stream is a buffer, the associated variable receives the text that has been output to the

stream. For example,

%assign x = ""                 /% Creates an empty string. %/
%openfile x
"hello, world"
%closefile x         /% x = "hello, world\n"%/

If desired, you can append to an output file or string by using the optional mode, a, as in

%openfile "foo.c", "a"             %% Opens foo.c for appending.

Input File Control
The input file control directives are

%include string
%addincludepath string

%include

The %include directive searches the path for the target file specified by string and includes the
contents of the file inline at the point where the %include statement appears.

%addincludepath

The %addincludepath directive adds an additional include path to be searched when the Target
Language Compiler references %include or block target files. The syntax is

%addincludepath string

The string can be an absolute path or an explicit relative path. For example, to specify an absolute
path, use

%addincludepath "C:\\folder1\\folder2"     (PC)
%addincludepath "/folder1/folder2"         (UNIX)

To specify a relative path, the path must explicitly start with .. For example,

%addincludepath ".\\folder2"                  (PC)
%addincludepath "./folder2"                   (UNIX)

Note that for PC, the backslashes must be escaped (doubled).

When an explicit relative path is specified, the folder that is added to the Target Language Compiler
search path is created by concatenating the location of the target file that contains the
%addincludepath directive and the explicit relative path.
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The Target Language Compiler searches the folders in the following order for target or include files:

1 The current folder.
2 Include paths specified in %addincludepath directives. The compiler evaluates multiple

%addincludepath directives from the bottom up.
3 Include paths specified at the command line via -I . The compiler evaluates multiple -I options

from right to left.

Typically, %addincludepath directives should be specified in your system target file. Multiple
%addincludepath directives will add multiple paths to the Target Language Compiler search path.

Note The compiler does not search the MATLAB path, and will not find a file that is available only on
that path. The compiler searches only the locations described above.

Asserts, Errors, Warnings, and Debug Messages
The related assert, error, warning, and debug message directives are

%assert expression
%error tokens
%warning tokens
%trace tokens
%exit tokens

These directives produce error, warning, or trace messages whenever a target file detects an error
condition, or tracing is desired. The tokens following the directive on a line become part of the
generated error or warning message.

The Target Language Compiler places messages generated by %trace onto stderr if and only if you
specify the verbose mode switch (-v) to the Target Language Compiler. See “Command-Line
Arguments” on page 19-48 for additional information about switches.

The %assert directive evaluates the expression and produces a stack trace if the expression
evaluates to a Boolean false.

Note In order for %assert directives to be evaluated, Enable TLC assertion must be selected in
the TLC process section of the Code Generation > Debug pane. The default action is for %assert
directives not to be evaluated.

The %exit directive reports an error and stops further compilation.

Built-In Functions and Values
The following table lists the built-in functions and values that are added to the list of parameters that
appear in the model.rtw file. These Target Language Compiler functions and values are defined in
uppercase so that they are visually distinct from other parameters in the model.rtw file, and, by
convention, from user-defined parameters.
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TLC Built-In Functions and Values

Built-In Function Name Expansion
CAST(expr, expr) The first expression must be a string that corresponds to one of the

type names in the table “Target Language Value Types” on page 19-13,
and the second expression will be cast to that type. A typical use might
be to cast a variable to a real format as in

CAST("Real", variable-name) 

An example of this is in working with parameter values for S-functions.
To use them within C or C++ code, you need to typecast them to real
so that a value such as 1 will be formatted as 1.0 (see also
%realformat).

EXISTS(var) If the var identifier is not currently in scope, the result is
TLC_FALSE. If the identifier is in scope, the result is TLC_TRUE. var
can be a single identifier or an expression involving the . and []
operators.

FEVAL(matlab-command,
   TLC-expressions)

Performs an evaluation in MATLAB. For example,

%assign result = FEVAL("sin",3.14159)

The %matlab directive can be used to call a MATLAB function that
does not return a result. For example,

%matlab disp(2.718)

Note: If the MATLAB function returns more than one value, TLC
receives the first value only.

FILE_EXISTS(expr) expr must be a string. If a file by the name expr does not exist on the
path, the result is TLC_FALSE. If a file by that name exists on the path,
the result is TLC_TRUE.

FORMAT(realvalue, format) The first expression is a Real value to format. The second expression
is either EXPONENTIAL or CONCISE. Outputs the Real value in the
designated format, where EXPONENTIAL uses exponential notation
with 16 digits of precision, and CONCISE outputs the number in a
more readable format while maintaining numerical accuracy.

FIELDNAMES(record) Returns an array of strings containing the record field names
associated with the record. Because it returns a sorted list of strings,
the function is O(n*log(n)).

GETFIELD(record,
   "fieldname")

Returns the contents of the specified field name, if the field name is
associated with the record. The function uses hash lookup, and
therefore executes in constant time.

GENERATE(record,
   function-name,  ...)

Executes function calls mapped to a specific record type (i.e., block
record functions). For example, use this to execute the functions in
the .tlc files for built-in blocks. Not that TLC automatically “scopes”
or adds the first argument to the list of scopes searched as if it
appears on a %with directive line.

GENERATE_FILENAME(type) For the specified record type, does a .tlc file exist? Use this to see if
the GENERATE_TYPE call will succeed.
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Built-In Function Name Expansion
GENERATE_FORMATTED_VALUE
   (expr, string, expand)

Returns a potentially multiline string that can be used to declare the
value(s) of expr in the current target language. The second argument
is a string that is used as the variable name in a descriptive comment
on the first line of the return string. If the second argument is the
empty string, "", then no descriptive comment is put into the output
string. The third argument is a Boolean that when TRUE causes expr
to be expanded into raw text before being output. expand = TRUE
uses much more memory than the default (FALSE); set expand =
TRUE only if the parameter text needs to be processed for some reason
before being written to disk.

For example,

static const unsigned char contents[] =

%assign value =
GENERATE_FORMATTED_VALUE(SFcnParamSettings.CONTENTS,
"", TLC_FALSE)

;

yields this C code:

static const unsigned char contents[] = { 0U, 1U, 2U,
3U, 4U };

GENERATE_FUNCTION_EXISTS
   (record, function-name)

Determines whether a given block function exists. The first expression
is the same as the first argument to GENERATE, namely a block scoped
variable containing a Type. The second expression is a string that
should match the function name.

GENERATE_TYPE
   (record, function-name,
   type, ...)

Similar to GENERATE, except that type overrides the Type field of the
record. Use this when executing functions mapped to specific S-
function block records based upon the S-function name (i.e., the name
becomes the type).

GENERATE_TYPE_FUNCTION_EXISTS
   (record, function-name,
   type)

Same as GENERATE_FUNCTION_EXISTS except that it overrides the
Type built into the record.

GET_COMMAND_SWITCH Returns the values of command-line switches. Only the following
switches are supported:

v, m, p, O, d, dr, r, I, a

See also “Command-Line Arguments” on page 19-48.
IDNUM(expr) expr must be a string. The result is a vector where the first element is

a leading string, if any, and the second element is a number appearing
at the end of the input string. For example,

IDNUM("ABC123") yields ["ABC", 123]
IMAG(expr) Returns the imaginary part of a complex number.
INT8MAX 127
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Built-In Function Name Expansion
INT8MIN -128
INT16MAX 32767
INT16MIN -32768
INT32MAX 2147483647
INT32MIN -2147483648
INTMIN Minimum integer value on host machine.
INTMAX Maximum integer value on host machine.
ISALIAS(record) Returns TLC_TRUE if the record is a reference (symbolic link) to a

different record, and TLC_FALSE otherwise.
ISEQUAL(expr1, expr2) Where the data types of both expressions are numeric: returns

TLC_TRUE if the first expression contains the same value as the
second expression; returns TLC_FALSE otherwise.

Where the data type of either expression is nonnumeric (e.g., string or
record): returns TLC_TRUE if and only if both expressions have the
same data type and contain the same value; returns TLC_FALSE
otherwise.

ISEMPTY(expr) Returns TLC_TRUE if the expression contains an empty string, vector,
or record, and TLC_FALSE otherwise.

ISFIELD(record, "fieldname") Returns TLC_TRUE if the field name is associated with the record, and
TLC_FALSE otherwise.

ISINF(expr) Returns TLC_TRUE if the value of the expression is inf, and
TLC_FALSE otherwise.

ISNAN(expr) Returns TLC_TRUE if the value of the expression is NAN, and
TLC_FALSE otherwise.

ISFINITE(expr) Returns TLC_TRUE if the value of the expression is not +/- inf or NAN,
and TLC_FALSE otherwise.

ISSLPRMREF(param.value) Returns a Boolean value indicating whether its argument is a
reference to a Simulink parameter or not. This function supports
parameter sharing with Simulink; using it can save memory and time
during code generation. For example,

%if !ISSLPRMREF(param.Value) 
  assign param.Value = CAST("Real", param.Value) 
%endif

NULL_FILE A predefined file for no output that you can use as an argument to
%selectfile to prevent output.

NUMTLCFILES The number of target files used thus far in expansion.
OUTPUT_LINES Returns the number of lines that have been written to the currently

selected file or buffer. Does not work for STDOUT or NULL_FILE.
REAL(expr) Returns the real part of a complex number.
REMOVEFIELD(record,
"fieldname")

Removes the specified field from the contents of the record. Returns
TLC_TRUE if the field was removed; otherwise returns TLC_FALSE.
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Built-In Function Name Expansion
ROLL_ITERATIONS() Returns the number of times the current roll regions are looping or

NULL if not inside a %roll construct.
SETFIELD(record, "fieldname",
value)

Sets the contents of the field name associated with the record. Returns
TLC_TRUE if the field was added; otherwise returns TLC_FALSE.

SIZE(expr[,expr]) Calculates the size of the first expression and generates a two-element
row vector. If the second operand is specified, it is used as an integer
index into this row vector; otherwise the entire row vector is returned.
SIZE(x) applied to a scalar returns [1 1]. SIZE(x) applied to a
scope returns the number of repeated entries of that scope type. For
example, SIZE(Block) returns

[1,<number of blocks>]

SPRINTF(format,var,...) Formats the data in variable var (and in any additional variable
arguments) under control of the specified format string, and returns a
string variable containing the values. Operates like the C library
sprintf(), except that output is the return value rather than
contained in an argument to sprintf.

STDOUT A predefined file for stdout output. You can use this as an argument
to %selectfile to force output to stdout.

STRING(expr) Expands the expression into a string; the characters \, \n, and " are
escaped by preceding them with \ (backslash). The ANSI escape
sequences are translated into string form. If %<> is in the expression,
it is escaped so that the enclosed string is not subject to further TLC
interpretation.

STRINGOF(expr) Accepts a vector of ASCII values and returns a string that is
constructed by treating each element as the ASCII code for a single
character. Used primarily for S-function string parameters.

SYSNAME(expr) Looks for specially formatted strings of the form <x>/y and returns x
and y as a two-element string vector. This is used to resolve subsystem
names. For example,

%<sysname("<sub>/Gain")>

returns

["sub","Gain"]

In Block records, the name of the block is written <sys/
blockname>, where sys is S# or Root. You can obtain the full path
name by calling LibGetBlockPath(block); this will include
newlines and other troublesome characters that cause display
difficulties. To obtain a full path name suitable for one-line comments
but not identical to the Simulink path name, use
LibGetFormattedBlockPath(block).

TLCFILES Returns a vector containing the names of the target files included thus
far in the expansion. Absolute paths are used. See also NUMTLCFILES.

TLC_FALSE Boolean constant that equals a negative evaluated Boolean expression.
TLC_TRUE Boolean constant that equals a positive evaluated Boolean expression.
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Built-In Function Name Expansion
TLC_TIME Date and time of compilation.
TLC_VERSION Version and date of the Target Language Compiler.
TYPE(expr) Evaluates expr and determines the result type. The result of this

function is a string that corresponds to the type of the given
expression. See the Value Type String column in the table “Target
Language Value Types” on page 19-13 for possible values.

UINT8MAX 255U
UINT16MAX 65535U
UINT32MAX 4294967295U
UINTMAX Maximum unsigned integer value on host machine.
WHITE_SPACE(expr) Accepts a string and returns 1 if the string contains only white-space

characters ( , \t, \n, \r); returns 0 otherwise.
WILL_ROLL(expr1, expr2) The first expression is a roll vector and the second expression is a roll

threshold. This function returns true if the vector contains a range
that will roll.

FEVAL Function

The FEVAL built-in function calls MATLAB file functions and MEX-functions. The structure is

%assign result = FEVAL( matlab-function-name, rhs1, rhs2, ... 
    rhs3, ... );

Note

• Only a single left-side argument is allowed when you use FEVAL.
• If your MATLAB function evaluation leads to an error, the TLC compiler does not terminate but

continues with the execution. The FEVAL directive returns an empty value to the TLC.

This table shows the conversions that are made when you use FEVAL.
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MATLAB Conversions

TLC Type MATLAB Type
"Boolean" Boolean (scalar or matrix)
"Number" Double (scalar or matrix)
"Real" Double (scalar or matrix)
"Real32" Double (scalar or matrix)
"Unsigned" Double (scalar or matrix)
"String" String
"Vector" If the vector is homogeneous, it is converted to a MATLAB vector. If

the vector is heterogeneous, it is converted to a MATLAB cell array.
"Gaussian" Complex (scalar or matrix)
"UnsignedGaussian" Complex (scalar or matrix)
"Complex" Complex (scalar or matrix)
"Complex32" Complex (scalar or matrix)
"Identifier" String
"Subsystem" String
"Range" Expanded vector of Doubles
"Idrange" Expanded vector of Doubles
"Matrix" If the matrix is homogeneous, it is converted to a MATLAB matrix. If

the matrix is heterogeneous, it is converted to a MATLAB cell array.
(Cell arrays can be nested.)

"Scope" or "Record" Structure with elements
Scope or Record alias String containing fully qualified alias name
Scope or Record array Cell array of structures
Other type not listed above Conversion not supported

When values are returned from MATLAB, they are converted as shown in this table. Note that
conversion of matrices with more than two dimensions is not supported, nor is conversion or
downcast of 64-bit integer values.
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More Conversions

MATLAB Type TLC Type
String String
Vector of Strings Vector of Strings
Boolean (scalar or matrix) Boolean (scalar or matrix)
INT8,INT16,INT32
(scalar or matrix)

Number (scalar or matrix)

INT64 Not supported
UINT64 Not supported
Complex INT8,INT16,INT32
(scalar or matrix)

Gaussian (scalar or matrix)

UINT8,UINT16,UINT32
(scalar or matrix)

Unsigned (scalar or matrix)

Complex UINT8,UINT16,UINT32
(scalar or matrix)

UnsignedGaussian (scalar or matrix)

Single precision Real32 (scalar or matrix)
Complex single precision Complex32 (scalar or matrix)
Double precision Real (scalar or matrix)
Complex double precision Complex (scalar or matrix)
Sparse matrix Expanded to matrix of Doubles
Cell array of structures Record array
Cell array of non-structures Vector or matrix of types converted from the

types of the elements
Cell array of structures and non-
structures

Conversion not supported

Structure Record
Object Conversion not supported

Other value types are not currently supported.

As an example, this statement uses the FEVAL built-in function to call MATLAB to take the sine of the
input argument.

%assign result = FEVAL( "sin", 3.14159 )

Variables (identifiers) can take on the following constant values. Note the suffix on the value .

Constant Form TLC Type
1.0 "Real"
1.0[F/f] "Real32"
1 "Number"
1[U|u] "Unsigned"
1.0i "Complex"
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Constant Form TLC Type
1[Ui|ui] "UnsignedGaussian"
1i "Gaussian"
1.0[Fi|fi] "Complex32"

Note The suffix controls the Target Language Compiler type obtained from the constant.

This table shows Target Language Compiler constants and their equivalent MATLAB values.

TLC Constants Equivalent MATLAB Value
rtInf, Inf, inf +inf
rtMinusInf -inf
rtNan, NaN, nan nan
rtInfi, Infi, infi inf*i
rtMinusInfi -inf*i
rtNaNi, NaNi, nani nan*i

TLC Reserved Constants
For double-precision values, the following are defined for infinite and not-a-number IEEE® values:

rtInf, inf, rtMinusInf, -inf, rtNaN, nan

For single-precision values, these constants apply:

rtInfF, InfF, rtMinusInfF, rtNaNF, NaNF

Their corresponding versions when complex are:

rtInfi, infi, rtMinusInfi, -infi, rtNaNi (for doubles)
rtInfFi, InfFi, rtMinusInfFi, rtNaNFi, NaNFi (for singles)

For integer values, the following are defined:

INT8MIN, INT8MAX, INT16MIN, INT16MAX, INT32MIN, INT32MAX, 
UINT8MAX, UINT16MAX, UINT32MAX, INTMAX, INTMIN, UINTMAX

Identifier Definition
To define or change identifiers (TLC variables), use the directive

%assign [::]expression = constant-expression

This directive introduces new identifiers (variables) or changes the values of existing ones. The left
side can be a qualified reference to a variable using the . and [] operators, or it can be a single
element of a vector or matrix. In the case of the matrix, only the single element is changed by the
assignment.

The %assign directive inserts new identifiers into the local function scope, file function scope,
generate file scope, or into the global scope. Identifiers introduced into the function scope are not
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available within functions being called, and are removed upon return from the function. Identifiers
inserted into the global scope are persistent. You can change existing identifiers by completely
respecifying them. The constant expressions can include legal identifiers from the .rtw files. You can
use %undef to delete identifiers in the same way that you use it to remove macros.

Within the scope of a function, variable assignments create new local variables unless you use the ::
scope resolution operator. In this example, the assignment creates a variable foo, local to the
function, that will disappear when the function exits.

%function ...
...
%assign foo = 3
...
%endfunction

Note that foo is created even if a global foo already exists.

To create or change values in the global scope, you must use the scope resolution operator (::) to
disambiguate, as in

%function ...
%assign foo = 3
%assign ::foo = foo
...
%endfunction

The scope resolution operator forces the compiler to assign the value of the local variable foo, 3, to
the global variable foo.

Note It is an error to change a value from the code generator file without qualifying it with the
scope. This example does not generate an error:

    %assign CompiledModel.name = "newname"    %% No error 

This example generates an error:

%with CompiledModel
  %assign name = "newname"       %% Error     %endwith

Creating Records

Use the %createrecord directive to build new records in the current scope. For example, if you
want to create a new record called Rec that contains two items (e.g., Name "Name" and Type "t"),
use

%createrecord Rec {  Name "Name"; Type "t" }

Adding Records

Use the %addtorecord directive to add new records to existing records. For example, if you have a
record called Rec1 that contains a record called Rec2, and you want to add an additional Rec2 to it,
use

%addtorecord Rec1 Rec2 {  Name "Name1"; Type "t1" }
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This figure shows the result of adding the record to the existing one.

If you want to access the new record, you can use

%assign myname = Rec1.Rec2[1].Name

In this same example, if you want to add two records to the existing record, use

%addtorecord Rec1 Rec2 {  Name "Name1"; Type "t1" }
%addtorecord Rec1 Rec2 {  Name "Name2"; Type "t2" }

This produces

Adding Parameters to an Existing Record

You can use the %assign directive to add a new parameter to an existing record. For example,
%addtorecord Block[Idx] N 500 /% Adds N with value 500 to Block %/
%assign myn = Block[Idx].N    /% Gets the value 500 %/

adds a new parameter, N, at the end of an existing block with the name and current value of an
existing variable, as shown in this figure. It returns the block value.
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Variable Scoping
This section discusses how the Target Language Compiler resolves references to variables (including
records).

Scope, in this document, has two related meanings. First, scope is an attribute of a variable that
defines its visibility and persistence. For example, a variable defined within the body of a function is
visible only within that function, and it persists only as long as that function is executing. Such a
variable has function (or local) scope. Each TLC variable has one (and only one) of the scopes
described in “Scopes” on page 19-38.

The term scope also refers to a collection, or pool, of variables that have the same scope. At a given
point in the execution of a TLC program, several scopes can exist. For example, during execution of a
function, a function scope (the pool of variables local to the function) exists. In all cases, a global
scope (the pool of global variables) also exists.

To resolve variable references, TLC maintains a search list of current scopes and searches them in a
well-defined sequence. The search sequence is described in “How TLC Resolves Variable References”
on page 19-42.

Dynamic scoping refers to the process by which TLC creates and deallocates variables and the scopes
in which they exist. For example, variables in a function scope exist only while the defining function
executes.

Scopes

The following sections describe the possible scopes that a TLC variable can have.
Global Scope

By default, TLC variables have global scope. Global variables are visible to, and can be referenced by,
code anywhere in a TLC program. Global variables persist throughout the execution of the TLC
program. Global variables are said to belong to the global pool.

Note that the CompiledModel record of the model.rtw file has global scope. Therefore, you can
access this structure from your TLC functions or files.

You can use the scope resolution operator (::) to explicitly reference or create global variables from
within a function. See “The Scope Resolution Operator” on page 19-41 for examples.

Note that you can use the %undef directive to free memory used by global variables.
File Scope

Variables with file scope are visible only within the file in which they are created. To limit the scope of
variables in this way, use the %filescope directive anywhere in the defining file.

In the following code fragment, the variables fs1 and fs2 have file scope. Note that the %filescope
directive does not have to be positioned before the statements that create the variables.

%assign fs1 = 1
%filescope
%assign fs2 = 3

Variables whose scope is limited by %filescope go out of scope when execution of the file
containing them completes. This lets you free memory allocated to such variables.
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Function (Local) Scope

Variables defined within the body of a function have function scope. That is, they are visible within
and local to the defining function. For example, in the following code fragment, the variable localv
is local to the function foo. The variable x is global.

%assign x = 3

%function foo(arg)
   %assign localv = 1
   %return x + localv
%endfunction

A local variable can have the same name as a global variable. To refer, within a function, to identically
named local and global variables, you must use the scope resolution operator (::) to disambiguate
the variable references. See “The Scope Resolution Operator” on page 19-41 for examples.

Note Functions themselves (as opposed to the variables defined within functions) have global scope.
There is one exception: functions defined in generate scope are local to that scope. See “Generate
Scope” on page 19-39.

%with Scope

The %with directive adds a new scope, referred to as a %with scope, to the current list of scopes.
This directive makes it easier to refer to block-scoped variables.

The structure of the %with directive is

%with expression
%endwith

For example, the directive

%with CompiledModel.System[sysidx]
   ...
%endwith

adds the CompiledModel.System[sysidx] scope to the search list. This scope is searched before
anything else. You can then refer to the system name simply by

Name

instead of

CompiledModel.System[sysidx].Name

Generate Scope

Generate scope is a special scope used by certain built-in functions that are designed to support code
generation. These functions dispatch function calls that are mapped to a specific record type. This
capability supports a type of polymorphism in which different record types are associated with
functions (analogous to methods) of the same name. Typically, this feature is used to map Block
records to functions that implement the functionality of different block types.

Functions that employ generate scope include GENERATE, GENERATE_TYPE,
GENERATE_FUNCTION_EXISTS, and GENERATE_TYPE_FUNCTION_EXISTS. See “GENERATE and
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GENERATE_TYPE Functions” on page 19-24. This section discusses generate scope using the
GENERATE built-in function as an example.

The syntax of the GENERATE function is

GENERATE(blk,fn)

The first argument (blk) to GENERATE is a valid record name. The second argument (fn) is the name
of a function to be dispatched. When a function is dispatched through a GENERATE call, TLC
automatically adds blk to the list of scopes that is searched when variable references are resolved.
Thus the record (blk) is visible to the dispatched function as if an implicit %with <blk>...
%endwith directive existed in the dispatched function.

In this context, the record named blk is said to be in generate scope.

Three TLC files, illustrating the use of generate scope, are listed below. The file polymorph.tlc
creates two records representing two hypothetical block types, MyBlock and YourBlock. Each
record type has an associated function named aFunc. The block-specific implementations of aFunc
are contained in the files MyBlock.tlc and YourBlock.tlc.

Using GENERATE calls, polymorph.tlc dispatches to a function for each block type. Notice that the
aFunc implementations can refer to the fields of MyBlock and YourBlock, because these records
are in generate scope.

• The following listing shows polymorph.tlc:

%% polymorph.tlc

%language "C"

%%create records used as scopes within dispatched functions

%createrecord MyRecord { Type "MyBlock"; data 123 }
%createrecord YourRecord { Type "YourBlock"; theStuff 666 }

%% dispatch the functions thru the GENERATE call.

%% dispatch to MyBlock implementation
%<GENERATE(MyRecord, "aFunc")> 

%% dispatch to YourBlock implementation
%<GENERATE(YourRecord, "aFunc")>

%% end of polymorph.tlc
• The following listing shows MyBlock.tlc:

%%MyBlock.tlc

%implements "MyBlock" "C"

%% aFunc is invoked thru a GENERATE call in polymorph.tlc.
%% MyRecord is in generate scope in this function.
%% Therefore, fields of MyRecord can be referenced without
%% qualification

%function aFunc(r) Output
%selectfile STDOUT
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The value of MyRecord.data is: %<data>
%closefile STDOUT
%endfunction

%%end of MyBlock.tlc

• The following listing shows YourBlock.tlc:

%%YourBlock.tlc

%implements "YourBlock" "C"

%% aFunc is invoked thru a GENERATE call in polymorph.tlc.
%% YourRecord is in generate scope in this function.
%% Therefore, fields of YourRecord can be referenced without
%% qualification

%function aFunc(r) Output
%selectfile STDOUT
The value of YourRecord.theStuff is: %<theStuff>
%closefile STDOUT
%endfunction

%%end of YourBlock.tlc

The invocation and output of polymorph.tlc, as displayed in the MATLAB Command Window, are
shown below:

tlc -v polymorph.tlc

The value of MyRecord.data is: 123
The value of YourRecord.theStuff is: 666

Note Functions defined in generate scope are local to that scope. This is an exception to the general
rule that functions have global scope. In the above example, for instance, neither of the aFunc
implementations has global scope.

The Scope Resolution Operator

The scope resolution operator (::) is used to indicate that the global scope should be searched when
a TLC function looks up a variable reference. The scope resolution operator is often used to change
the value of global variables (or even create global variables) from within functions.

By using the scope resolution operator, you can resolve ambiguities that arise when a function
references identically named local and global variables. In the following example, a global variable
foo is created. In addition, the function myfunc creates and initializes a local variable named foo.
The function myfunc explicitly references the global variable foo by using the scope resolution
operator.

%assign foo = 3   %% this variable has global scope
.
.
.
%function myfunc(arg)
   %assign foo = 3   %% this variable has local scope
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   %assign ::foo = arg   %% this changes the global variable foo
%endfunction

You can also use the scope resolution operator within a function to create global variables. The
following function creates and initializes a global variable:

%function sideffect(arg)
   %assign ::theglobal = arg   %% this creates a global variable
%endfunction

How TLC Resolves Variable References

This section discusses how the Target Language Compiler searches the existing scopes to resolve
variable references.

Global Scope

In the simplest case, the Target Language Compiler resolves a variable reference by searching the
global pool (including the CompiledModel structure).

%with Scope

You can modify the search list and search sequence by using the %with directive. For example, when
you add the following construct,

%with CompiledModel.System[sysidx]
   ...
%endwith

the System[sysidx] scope is added to the search list. This scope is searched first, as shown by this
picture.

This technique makes it simpler to access embedded definitions. Using the %with construct (as in the
previous example), you can refer to the system name simply by

Name

instead of

CompiledModel.System[sysidx].Name

Function Scope

A function has its own scope. That scope is added to the previously described search list, as shown in
this diagram.
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For example, in the following code fragment,

% with CompiledModel.System[sysidx]
...
   %assign a=foo(x,y)
...
%endwith
...
%function foo(a,b)
...
   assign myvar=Name
...
%endfunction
...
%<foo(1,2)>

If Name is not defined in foo, the assignment uses the value of Name from the previous scope,
CompiledModel.System[SysIdx].Name.

In a nested function, only the innermost function scope is searched, together with the enclosing
%with and global scopes, as shown in the following diagram:
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File Scope

File scopes are searched before the global scope, as shown in the following diagram.
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The rule for nested file scopes is similar to that for nested function scopes. In the case of nested file
scopes, only the innermost nested file scope is searched.

Target Language Functions
The target language function construct is

%function identifier ( optional-arguments ) [Output | void]
%return
%endfunction

Functions in the target language are recursive and have their own local variable space. Target
language functions do not produce output unless they are output functions or explicitly use the
%openfile, %selectfile, and %closefile directives.

A function optionally returns a value with the %return directive. The returned value can be a type
defined in the table at “Target Language Value Types” on page 19-13.

In this example, a function, name, returns x if x and y are equal, or returns z if x and y are not equal:

%function name(x,y,z) void

%if x == y
   %return x
%else
   %return z
%endif

%endfunction

Function calls can appear in contexts where variables are allowed.

The %with statements that are in effect when a function is called are available to the function. Calls
to other functions do not include the local scope of the function, but do include %with statements
appearing within the function.

Assignments to variables within a function create new local variables and cannot change the value of
global variables unless you use the scope resolution operator (::).

By default, a function returns a value and does not produce output. You can override this behavior by
specifying the Output and void modifiers on the function declaration line, as in

%function foo() Output
...
%endfunction

In this case, the function continues to produce output to the currently open file, and is not required to
return a value. You can use the void modifier to indicate that the function does not return a value
and should not produce output, as in

%function foo() void
...
%endfunction
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Variable Scoping Within Functions

Within a function, the left-hand member of an %assign statement defaults to creating a local
variable. A new entry is created in the function’s block within the scope chain; it does not affect the
other entries. An example appears in “Function Scope” on page 19-42.

You can override this default behavior by using %assign with the scope resolution operator (::).

When you introduce new scopes within a function, using %with, these new scopes are used during
nested function calls, but the local scope for the function is not searched.

If a %with is included within a function, its associated scope is carried with nested function calls, as
shown in the next figure.

%return

The %return statement closes all %with statements appearing within the current function. In this
example, the %with statement is automatically closed when the %return statement is encountered,
removing the scope from the list of searched scopes:

%function foo(s)
    %with s
        %return(name)
    %endwith
%endfunction
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The %return statement does not require a value. You can use %return to return from a function
without a return value.

See Also

Related Examples
• “Command-Line Arguments” on page 19-48
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Command-Line Arguments

Target Language Compiler Switches
To call the Target Language Compiler, use

tlc [switch1 expr1 switch2 expr2 ...] filename.tlc

This table lists the switches you can use with the Target Language Compiler. Order does not makes a
difference. Note that if you specify a switch more than once, the last one takes precedence.
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Target Language Compiler Switches

Switch Meaning
-r filename Reads a database file (such as an .rtw file). Repeat this option

multiple times to load multiple database files into the Target
Language Compiler. Omit this option for target language programs
that do not depend on the database.

-v[number] Sets the internal verbosity level to number. Omitting this option
sets the verbosity level to 1.

-Ipath Adds the specified folder to the list of paths to be searched for TLC
files.

-Opath Specifies that the output produced should be placed in the
designated folder, including files opened with %openfile and
%closefile, and .log files created in debug mode. To place files
in the current folder, use -O (use the capital letter O, not zero).

-m[number] The number specifies the maximum number of errors to report .
Without -m, the default is to report the first five errors. If the
number argument is omitted on this option, 1 is assumed.

-x0 Parse TLC file only (do not execute).
-lint Performs some simple checks for performance and obsolete

features.
-p[number] Prints a dot (.) indicating progress for every number of TLC

primitive operations executed.
-d[a|c|f|n|o] Invokes the TLC’s debug mode.

-da makes TLC execute %assert directives. However, when using
the build process, this flag is ignored, because it is superseded by
the Enable TLC assertion check box in the TLC process section
of the Code Generation > Debug pane.

-dc invokes the TLC command-line debugger.

-df filename invokes the TLC debugger and runs the debugger
script specified by filename. A debugger script is a text file
containing valid debugger commands. TLC searches only the
current working folder for the script file.

-dn causes TLC to produce log files indicating which lines were
and were not reached during compilation.

-do disables the TLC debugging behavior.
-dr Checks for cyclic records (records that reference each other, a

source of memory leaks).
-a[ident]=expr Specifies an initial value, expr, for the identifier, ident, for some

parameters; equivalent to the %assign command.
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Switch Meaning
-shadow[0|1] Enables a warning when an identifier-value pair of a record

overwrites a local variable. The warning is disabled by default.

-shadow0 disables the warning.

-shadow1 enables the warning.

As an example, the command line

tlc -r myModel.rtw -v grt.tlc

specifies that myModel.rtw should be read and used to process grt.tlc in verbose mode.

Filenames and Search Paths
Target files have the .tlc extension. By default, block-level files have the same name as the Type of
the block in which they appear. You can override the search path for target files with your own local
versions. The Target Language Compiler finds target files along this path. If you specify additional
search paths with the -I switch of the tlc command or via the %addincludepath directive, the
search order is:

1 Current folder.
2 Include paths specified in %addincludepath directives. The compiler evaluates multiple

%addincludepath directives from the bottom up.
3 Include paths specified at the command line via -I . The compiler evaluates multiple -I options

from right to left.

Note The compiler does not search the MATLAB path, and will not find a file that is available only on
that path. The compiler searches only the locations described above.

See Also

Related Examples
• “Target Language Compiler Directives” on page 19-2
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Debugging TLC Files

The Target Language Compiler debugger is a command-line debugger that enables you to identify
problems in executing TLC code. The following sections describe the facilities provided and provide
examples of use.

• “Using the TLC Debugger” on page 20-2
• “TLC Coverage” on page 20-6
• “TLC Profiler” on page 20-9
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Using the TLC Debugger
The TLC debugger helps you identify programming errors in your TLC code. Using the debugger, you
can execute TLC code line-by-line, analyze and/or change variables in a specified block scope, and
view the TLC call stack. The TLC debugger has a command-line interface that provides commands
similar to standard debugging tools such as dbx or gdb.

Tips for Debugging TLC Code
Here are a few tips that will help you to debug your TLC code:

1 To see the full TLC call stack, place the following statement in your TLC code before the line that
is pointed to by the error message. This will be helpful in narrowing down your problem.

%setcommandswitch "-v1"
2 To trace the value of a variable in a function, place the following statement in your TLC file:

%trace This is in my function %<variable>

Your message will appear when the Target Language Compiler is run with the -v command
switch, but not otherwise. You can use %warning instead of %trace to print variables, but you
will need to remove or comment out such lines after you are through debugging.

3 Use the TLC coverage log files to identify parts of your code that have not been reached.

Invoking the Debugger
Use the TLC debugger to identify bugs and potential problems in your TLC files. To use the TLC
debugger:

1 On the Configuration Parameters dialog box, select “Retain .rtw file”. This prevents the
model.rtw file from being deleted after code generation.

2 Select “Start TLC debugger when generating code” to invoke the TLC debugger when starting
the code generation process.

Selecting Start TLC debugger when generating code is equivalent to specifying the TLC
option -dc on the Code Generation pane of the Configuration Parameters dialog box.

3 Apply changes and start code generation by pressing Ctrl+B. This stops at the first line of
executed TLC code, breaks into the TLC command-line debugger, and displays the following
prompt:

TLC_DEBUG>

You can now set breakpoints, explore the contents of code generator files, and explore variables in
your TLC file using print, which, or whos.

An alternative way to invoke the TLC debugger is from the MATLAB prompt. (This assumes you
retained the model.rtw file in the project folder.) To avoid making mistakes, copy the tlc command
output of the build process to the MATLAB Command Window, and issue it after appending -dc to
that command line.

A complete list of command-line switches for the TLC debugger is available in the table “Target
Language Compiler Switches” on page 19-48.
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TLC Debugger Command Summary
The table TLC Debugger Commands summarizes the TLC debugger commands.

To obtain more detailed help on individual commands, use the syntax

help command

from within the TLC debugger, as in this example:

TLC-DEBUG> help clear

You can abbreviate a TLC debugger command to its shortest unique form. For example,

TLC-DEBUG> break warning

can be abbreviated to

TLC-DEBUG> br warning

To view a complete list of TLC debugger commands, type help at the TLC-DEBUG> prompt.

 Using the TLC Debugger
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TLC Debugger Commands

Command Description
assign variable=value Change a variable in the running program.
break ["filename":]line|error|warning|
trace|function

Set a breakpoint. See also “%breakpoint Directive” on
page 20-5.

clear [breakpoint#|all] Remove a breakpoint.
condition [breakpoint#] [expression] Attach a condition to a breakpoint.
continue ["filename":]line|function Continue from a breakpoint.
disable [breakpoint#] Disable a breakpoint.
down [n] Move down the stack.
enable [breakpoint#] Enable a breakpoint.
finish Break after completing the current function.
help [command] Obtain help for a command.
ignore [breakpoint#]count Set the ignore count of a breakpoint.
iostack Display contents of I/O stack.
list start[,end] List lines from the file from start to end.
loadstate "filename" Load debugger breakpoint state from a file.
next Single step without going into functions.
print expression Print the value of a TLC expression. To print a record,

you must specify a fully qualified scope such as
CompiledModel.System[0].Block[0].

quit Quit the TLC debugger. You can also exit the debugger
by typing Ctrl+C at the prompt.

run "filename" Run a batch file of command-line debugger commands.
savestate "filename" Save debugger breakpoint state to a file.
status Display a list of active breakpoints.
step Step into.
stop ["filename":]line|error|warning|
trace|
function

Set a breakpoint (same as break).

tbreak ["filename":]line|function Set a temporary breakpoint.
thread [n] Change the active thread to thread #n (0 is the main

program’s thread number).
threads List the currently active TLC execution threads.
tstop ["filename":]line|function Set a temporary breakpoint.
up [n] Move up the stack.
where Show the currently active execution chains.
which name Look up the name and display what scope it comes from.
whos [::|expression] List the variables in the given scope.
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%breakpoint Directive

As an alternative to the break command, you can embed breakpoints at locations in a TLC file by
adding the directive

%breakpoint

Usage Notes

When using break or stop, use

• error to break or stop on error
• warn to break or stop on warning
• trace to break or stop on trace

For example, if you need to break on error, use

TLC_DEBUG> break error

When using clear, get the status of breakpoints using status and clear specific breakpoints. For
example

TLC-DEBUG> break "foo.tlc":46
TLC-DEBUG> break "foo.tlc":25
TLC-DEBUG> status
Breakpoints:
[1] break File: foo.tlc Line: 46
[2] break File: foo.tlc Line: 25
TLC-DEBUG> clear 2

In this example, clear 2 clears the second breakpoint.

See Also

Related Examples
• “Debug Your TLC Code” on page 16-26
• “TLC Code Coverage to Aid Debugging” on page 16-32
• “TLC Coverage” on page 20-6
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TLC Coverage

Using the TLC Coverage Option
The example in “Using the TLC Debugger” on page 20-2 used the debugger to detect a problem in
one section of the TLC file. Because a test model may not cover all possible cases, there is a
technique that traces the untested cases, the TLC coverage option.

The TLC coverage option provides an easier way to ascertain that the different code parts (not paths)
in your code are exercised. To specify TLC coverage tracking, on the Configuration Parameters dialog
box, select “Start TLC coverage when generating code”.

When you initiate TLC coverage, the Target Language Compiler produces a .log file for every target
file (*.tlc) used. These .log files are placed in project folder created for the model. Each .log file
contains usage (count) information regarding how many times it encounters each line during
execution. Each line begins with the number of times it is encountered, followed by a colon, followed
by the code.

Example .log File
Here is a log file that results from generating code for the example model sfcndemo_sdotproduct,
located in the folder matlabroot/toolbox/simulink/simdemos/simfeatures (open). This
model inlines the sdotproduct S-function in TLC. The TLC file that implements the S-function is
located in the folder matlabroot/toolbox/simulink/simdemos/simfeatures/tlc_c (open).
The .log file for sdotproduct.tlc is sdotproduct.log, which is placed in your build folder. The
contents of sdotproduct.log are similar to:
Source: E:\matlab\toolbox\simulink\simdemos\simfeatures\tlc_c\sdotproduct.tlc
 0: %% 
 0: %% File : sdotproduct.tlc generated from sdotproduct.ttlc revision 1.6
 0: %%
 0: %% Abstract:
 0: %%      Dot product block target file.
 1: 
 1: %implements sdotproduct "C"
 1: 
 0: %% Function: FcnThriftedComplexMultiply 
========================================
 0: %% Abstract:
 0: %%      This function multiplies two numbers in the complex plane. If any of
 0: %%      the input arguments is only real, then the complex part is passed in
 0: %%      as "".
 0: %%
 1: %function FcnThriftedComplexConjMultiply(ar,ai,br,bi,cr,ci,op) void
 2:   %openfile buffer
 0:   %%
 0:   %% Compute Cr = Ar * Br + Ai * Bi
 0:   %%
 2:   %assign rhsStr = "%<ar> * %<br>"
 2:   %if !LibIsEqual(ai, "") && !LibIsEqual(bi, "")
 0:     %assign rhsStr = rhsStr + " + %<ai> * %<bi>"
 0:   %endif
 2:   %<cr> %<op> %<rhsStr>;
 0:   %%
 0:   %% Compute Ci = Ar * Bi - Ai * Br
 0:   %%
 2:   %if !LibIsEqual(ci, "")
 0:     %assign rhsStr = "0.0"
 0:     %if !LibIsEqual(bi, "")
 0:       %assign rhsStr = "%<ar> * %<bi>"
 0:     %endif
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 0:     %if !LibIsEqual(ai, "")
 0:       %assign rhsStr = rhsStr + " - %<ai> * %<br>"
 0:     %endif
 0:     %<ci> %<op> %<rhsStr>;
 0:   %endif
 0:   %%
 2:   %closefile buffer
 2:   %return buffer
 0: %endfunction %% FcnThriftedComplexMultiply
 1: 
 1: 
 0: %% Function: Outputs 
===========================================================
 0: %% Abstract:
 0: %%      Y = U0' * U1, where U0' is the complex conjugate transpose of U0
 0: %%
 1: %function Outputs(block, system) Output
 1:   %assign sfcnName = ParamSettings.FunctionName
 1:   /* %<Type> Block (%<sfcnName>): %<LibParentMaskBlockName(block)> */
 0:   %%
 1:   %assign u0re = LibBlockInputSignal(0, "", "", "%<tRealPart>0")
 1:   %assign u0im = LibBlockInputSignal(0, "", "", "%<tImagPart>0")
 1:   %assign u1re = LibBlockInputSignal(1, "", "", "%<tRealPart>0")
 1:   %assign u1im = LibBlockInputSignal(1, "", "", "%<tImagPart>0")
 0:   %%
 1:   %assign yre = LibBlockOutputSignal(0, "", "", "%<tRealPart>0")
 1:   %assign yim = LibBlockOutputSignal(0, "", "", "%<tImagPart>0")
 0:   %%
 0:   %% Need to declare a temporary variable for u1re when the output is
 0:   %% being overwritten and u0im is nonzero
 1:   %assign outputOverWritesInput = ...
 0:     ((LibBlockInputSignalBufferDstPort(0) == 0) || ...
 0:      (LibBlockInputSignalBufferDstPort(1) == 0)) &&   ...
 0:     (LibBlockInputSignalIsComplex(0) && LibBlockInputSignalIsComplex(1))
 0:   %%
 1:   %if outputOverWritesInput
 0:     {
 0:       %assign dtName = LibBlockOutputSignalDataTypeName(0, tRealPart)
 0:       %<dtName> tmpVar;
 0:     \
 0:     %assign tmpVar = "tmpVar"
 0:   %else
 1:     %assign tmpVar = yre
 0:   %endif
 0:   %%
 1:   %<FcnThriftedComplexConjMultiply(u0re, u0im, u1re, u1im, tmpVar, yim, "=")>\
 0:   %%
 1:   %assign rollVars    = ["U", "Y"]
 1:   %assign rollRegion  = LibGetRollRegions1(RollRegions)
 0:   %%
 1:   %if LibIsEqual(rollRegion, []) 
 0:     %if outputOverWritesInput
 0:       %<yre> = tmpVar;
 0:     %endif
 0:   %else
 0:     %% Continue with dot product for nonscalar case
 1:     %roll idx = rollRegion, lcv = RollThreshold, block, "Roller", rollVars
 1:       %assign u0re = LibBlockInputSignal(0,"",lcv,"%<tRealPart>%<idx>")
 1:       %assign u0im = LibBlockInputSignal(0,"",lcv,"%<tImagPart>%<idx>")
 1:       %assign u1re = LibBlockInputSignal(1,"",lcv,"%<tRealPart>%<idx>")
 1:       %assign u1im = LibBlockInputSignal(1,"",lcv,"%<tImagPart>%<idx>")
 0:       %%               
 1:       %assign yre = LibBlockOutputSignal(0,"",lcv,"%<tRealPart>%<idx>")
 1:       %assign yim = LibBlockOutputSignal(0,"",lcv,"%<tImagPart>%<idx>")
 0:       %%
 1:       %<FcnThriftedComplexConjMultiply(u0re, u0im, u1re, u1im, yre, yim, "+=")>\
 0:     %endroll
 0:   %endif
 1:   %if outputOverWritesInput
 0:     }
 0:   %endif
 1: 
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 0: %endfunction
 1: 
 0: %% [EOF] sdotproduct.tlc

Analyzing the Results
This structure makes it easy to identify branches not taken and to develop new tests that can exercise
unused portions of the target files.

Looking at the sdotproduct.log file, you can see that the code has not been used to assign default
values to parameters (e.g., the first part of the code for function
FcnThriftedComplexConjMultiply). Using this log as a reference and creating models that
exercise unexecuted lines, you can make sure that your code is more robust.

See Also

Related Examples
• “Debug Your TLC Code” on page 16-26
• “TLC Code Coverage to Aid Debugging” on page 16-32
• “TLC Profiler” on page 20-9
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TLC Profiler

Using the Profiler
The TLC profiler collects timing statistics for TLC code. It collects execution time for functions,
scripts, macros, and built-in functions. These results become the basis of HTML reports that are
identical in format to MATLAB profiler reports. By analyzing the report, you can identify bottlenecks
in your code that make code generation take longer.

On the Configuration Parameters dialog box, select “Profile TLC”. Apply your changes and press Ctrl
+B.

At the end of the TLC process, the build process creates the HTML summary and related files.

Analyzing the Report
The profile report is generated into the build folder. To open the report, change folder (cd) to the
build folder and open the file model.html, opening it in a browser window. Here is a sample of a
TLC profiling report:

 TLC Profiler
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The created report is fairly self-explanatory. Some points to note are

• Functions are sorted in descending order of their execution time.
• Self-time is the time spent in the function alone, not including the time spent in functions called by

the function.
• Functions are hyperlinks that take you to the details related to that specific function.

The profiler report can be helpful when you have inlined S-functions in your model. You can use the
profiler to compare time spent in specific user-written or Lib functions, and then modify your TLC
code accordingly.

Nonexecutable Directives
TLC considers the following directives to be nonexecutable lines. Therefore, these directives are not
counted in TLC Profiler reports:

• %filescope
• %else
• %endif
• %endforeach
• %endfor
• %endroll
• %endwith
• %body
• %endbody
• %endfunction
• %endswitch
• %default
• Comment (%% or /% text %/

Improving Performance
Analyzing the profiler results also gives you an overview of which functions are used more often or
are more expensive. Then, you can either improve those functions, or try alternative methods to
improve code generation speed. Two points to consider are

• Reduce usage of EXISTS. Performing an EXISTS on a field is more costly than comparing the field
to a value. When possible, create an inert default value for a field. Then, instead of doing an
EXISTS on the entity, compare it against the default value.

• Reduce the use of one-line functions. One-line functions might be a bottleneck for code generation
speed. When readability is not an issue, consider expanding the function.
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See Also

Related Examples
• “TLC Coverage” on page 20-6
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Inlining S-Functions

To wrap or to inline, that is the question. Once you have decided, the following sections explain how
to go about it, using the timestwo S-function as a running example. Inlining works almost identically
for C, C++, MATLAB file, and Fortran S-functions.

• “Inline S-Functions” on page 21-2
• “Inline C MEX S-Functions” on page 21-8
• “TLC Coding Conventions” on page 21-17
• “Block Target File Methods” on page 21-21
• “Loop Rolling” on page 21-27
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Inline S-Functions
Writing S-functions to be included in generated code involves requirements that go beyond writing S-
functions used only for simulation. Before you proceed to inline an S-function make sure that it meets
requirements and functions as you expect. For more information, see “S-Functions and Code
Generation”. If your S-function is multirate, see “Time-Based Scheduling and Code Generation” and
“Modeling for Multitasking Execution”, and “Rate Grouping Compliance and Compatibility Issues” on
page 66-13.

Inline S-Functions with Block Target Files
When to Inline S-Functions

With C MEX S-functions, non-ERT targets support calling the original C MEX code if the source code
(.c file) is available when entering the build phase. For S-functions that are in Fortran or MATLAB
language, you must inline them to have complete code generation for Simulink models that contain
them. Additionally, once you have determined that you will inline an S-function, you must decide to
make it either fully inlined or wrapped.

Fully Inlined S-Functions

The block target file for a fully inlined S-function is a self-contained definition of how to inline the
block’s functionality directly into the various portions of the generated code — start code, output
code, etc. This approach is most beneficial when there are many modes and data types supported for
algorithms that are relatively small or when the code size is not significant.

Function-Based or Wrapped Code Generation

When the physical size of the code for a block becomes too large for inlining, the block target file is
written to gather inputs, outputs, and parameters, and make a call to a function that you write to
perform the block functionality. This has an advantage in generated code size when the code in the
function is large or there are many instances of this block in a model. Of course, you should consider
the overhead of the function call when weighing the option of fully inlining the block algorithm or
generating function calls.

If you choose to go with function-based code generation, two more options need consideration:

• Write the functions once, put them in .c files, and have the TLC code’s BlockTypeSetup method
specify external references to your support functions. Use LibAddToModelSources for names of
the modules containing the supporting functions. This approach is usually done using one function
per file to get the smallest executable possible.

• Write a more sophisticated TLC file. In addition to methods such as Start and Outputs,
conditionally generate customized versions of functions (data types, widths, algorithms, and so
on), in separate code generation buffers, to be written to a separate .c file. The file should contain
only functions used by this model, instead of all possible functions.

Either approach can produce optimal code. The first option can result in hundreds of files if your S-
function supports many data types, signal widths, and algorithm choices. The second approach is
more difficult to write, but results in a more maintainable code generation library, and the code can
be every bit as tight as the first approach.

For further information on wrapping, see “Wrapper Inlined S-Function Example” on page 15-11.
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Inline MATLAB File S-Functions
You can inline the functionality of MATLAB file S-functions in the generated code. The process for
writing a block target file for a MATLAB file S-function is essentially identical to the process for
writing a C MEX S-function.

Note While you can fully inline a MATLAB file S-function to improve performance, Simulink
Accelerator or the code generator does not include a C or C++ API for the MATLAB Math Library.
You therefore cannot call MATLAB Math Library functions from a TLC file.

The following example illustrates the equivalence of C MEX and MATLAB file S-functions for code
generation. The S-function MATLAB file timestwo.m is equivalent to the C MEX S-function
timestwo. The TLC file for the C MEX S-function timestwo works for the S-function MATLAB file
timestwo.m. TLC is independent of the type of S-function because TLC requires only the root name
of the S-function and not its type. In the case of timestwo, one line determines how the code
generator implements the TLC file:

%implements "timestwo" "C"

To try this yourself:

1 Create the following sample model:

2 Copy the file timestwo.m from the folder matlabroot/toolbox/simulink/simdemos/
simfeatures (open) to a temporary folder.

3 Copy the file timestwo.tlc from the folder matlabroot/toolbox/simulink/simdemos/
simfeatures/tlc_c (open) to the same temporary folder.

4 In MATLAB, change folder (cd) to the temporary folder and make a Simulink model with an S-
function block that calls timestwo.

5 On the Signal Attributes tab of the Inport Block Parameters dialog box, set the Port
dimensions parameter to 5.

Simulink uses the MATLAB file S-function for simulation because the MATLAB search path finds
timestwo.m in the current folder before finding the C MEX S-function timestwo in the
matlabpath. Verify which S-function the code generator uses by typing the MATLAB command:

which timestwo

The answer is the MATLAB file S-function timestwo.m in the temporary folder.

In the generated code, the timestwo.tlc file inlines the MATLAB file S-function.
/* S-Function (timestwo): '<Root>/MATLAB S-Function' */
  /* Multiply input by two */
  {
    int_T i1;
    const real_T *u0 = &times2_B.Gain[0];
    real_T *y0 = &times2_Y.Out1[0];
    for (i1=0; i1 < 5; i1++) {
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      y0[i1] = u0[i1] * 2.0;
    }
  }

The output is the product of each input, u0[i1] times 2.0. The code generator uses this Outputs
method from the block target file to generate code:
%function Outputs(block, system) Output
/* %<Type> Block: %<Name> */
  %%
  /* Multiply input by two */
  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
    %<LibBlockOutputSignal(0, "", lcv, idx)> = \
    %<LibBlockInputSignal(0, "", lcv, idx)> * 2.0;
  %endroll
%endfunction

Alter these temporary copies of the MATLAB file S-function and the TLC file to see how they interact.
Start out by just changing the comments in the TLC file and see the changes that appear in the
generated code. Then, work up to algorithmic changes.

For more information on inlining C MEX S-Functions, see “Inline C MEX S-Functions” on page 21-
8.

Inline Fortran (F-MEX) S-Functions
The capabilities of Fortran MEX S-functions can be fully inlined using a TLC block target file. This
interface can be illustrated with a Fortran MEX S-function that implements the timestwo function.
Here is the sample Fortran S-function code:

C
C     FTIMESTWO.FOR
C     
C
C     A sample FORTRAN representation of a 
C     timestwo S-function.
C     Copyright 1990-2000 The MathWorks, Inc.
C
C=====================================================
C     Function:  SIZES
C       
C     Abstract:
C       Set the size vector.
C
C       SIZES returns a vector which determines model 
C       characteristics.  This vector contains the 
C       sizes of the state vector and other
C       parameters. More precisely,
C       SIZE(1)  number of continuous states
C       SIZE(2)  number of discrete states
C       SIZE(3)  number of outputs
C       SIZE(4)  number of inputs
C       SIZE(5)  number of discontinuous roots in 
C                the system
C       SIZE(6)  set to 1 if the system has direct 
C                feedthrough of its inputs, 
C                otherwise 0
C
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C=====================================================
      SUBROUTINE SIZES(SIZE)
C     .. Array arguments ..
      INTEGER*4        SIZE(*)
C     .. Parameters ..
      INTEGER*4       NSIZES
      PARAMETER       (NSIZES=6)

      SIZE(1) = 0
      SIZE(2) = 0
      SIZE(3) = 1
      SIZE(4) = 1
      SIZE(5) = 0
      SIZE(6) = 1

      RETURN
      END

C
C=====================================================
C     Function:  OUTPUT
C
C     Abstract:  
C       Perform output calculations for continuous 
C       signals.
C=====================================================
C     .. Parameters ..
      SUBROUTINE OUTPUT(T, X, U, Y)
      REAL*8           T
      REAL*8           X(*), U(*), Y(*)

      Y(1) = U(1) * 2.0

      RETURN
      END

C
C=====================================================
C     Stubs for unused functions.
C=====================================================

      SUBROUTINE INITCOND(X0)
      REAL*8           X0(*)
C --- Nothing to do.
      RETURN
      END

      SUBROUTINE DERIVS(T, X, U, DX)
      REAL*8           T, X(*), U(*), DX(*)
C --- Nothing to do.
      RETURN
      END

      SUBROUTINE DSTATES(T, X, U, XNEW)
      REAL*8           T, X(*), U(*), XNEW(*)
C --- Nothing to do.
      RETURN
      END
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      SUBROUTINE DOUTPUT(T, X, U, Y)
      REAL*8           T, X(*), U(*), Y(*)
C --- Nothing to do.
      RETURN
      END
      
      SUBROUTINE TSAMPL(T, X, U, TS, OFFSET)
      REAL*8           T,TS,OFFSET,X(*),U(*)
C --- Nothing to do.
      RETURN
      END
      
      SUBROUTINE SINGUL(T, X, U, SING)
      REAL*8           T, X(*), U(*), SING(*)
C --- Nothing to do.
      RETURN
      END

Copy the preceding code into file ftimestwo.for in a convenient working folder.

Putting this into an S-function block in a simple model will illustrate the interface for inlining the S-
function. Once your Fortran MEX environment is set up, prepare the code for use by compiling the S-
function in a working folder along with the file simulink.for from the folder matlabroot/
simulink/src (open). For more information about setting up your Fortran MEX environment, see
“Create Level-2 Fortran S-Functions”.

Compile the code with the mex command at the MATLAB command line:

mex ftimestwo.for simulink.for

Now reference this block from a simple model set with a fixed-step solver and the grt target.

The TLC code for inlining this block is a modified form of timestwo.tlc. In your working folder,
create a file named ftimestwo.tlc and put this code into it.

%implements "ftimestwo" "C"

%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %%
  /* Multiply input by two */
  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, ... 
"Roller", rollVars
    %<LibBlockOutputSignal(0, "", lcv, idx)> = \
    %<LibBlockInputSignal(0, "", lcv, idx)> * 2.0;
  %endroll
%endfunction

Now you can generate code for the ftimestwo Fortran MEX S-function. The resulting code fragment
specific to ftimestwo is
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/* S-Function Block: <Root>/F-MEX S-Function */
  /* Multiply input by two */
  rtB.F_MEX_S_Function = rtB.Gain * 2.0;

See Also

Related Examples
• “Write Wrapper S-Function and TLC Files”
• “Write Fully Inlined S-Functions”
• “Write Fully Inlined S-Functions with mdlRTW Routine”
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Inline C MEX S-Functions

Inline S-Function Overview
When a Simulink model contains an S-function and a corresponding TLC block target file exists for
that S-function, the code generator inlines the S-function. Inlining an S-function can produce more
efficient code by eliminating the S-function API layer from the generated code.

For S-functions that can perform a variety of tasks, inlining them gives you the opportunity to
generate code only for the current mode of operation set for each instance of the block. As an
example of this, if an S-function accepts an arbitrary signal width and loops through each element of
the signal, you would want to generate inlined code that has loops when the signal has two or more
elements, but generates a simple nonlooped calculation when the signal has just one element.

Level 1 C MEX S-functions (written to an older form of the S-function API) that are not inlined will
cause the generated code to make calls to all of these functions even if the routine is empty for the
particular S-function.

Function Purpose
mdlInitializeSizes Initialize the sizes array
mdlInitializeSampleTimes Initialize the sample times array
mdlInitializeConditions Initialize the states
mdlOutputs Compute the outputs
mdlUpdate Update discrete states
mdlDerivatives Compute the derivatives of continuous states
mdlTerminate Clean up when the simulation terminates

Level 2 C MEX S-functions (i.e., those written to the current S-function API) that are not inlined make
calls to the above functions, with the following exceptions:

• mdlInitializeConditions is called only if MDL_INITIALIZE_CONDITIONS is declared with
#define.

• mdlStart is called only if MDL_START is declared with #define.
• mdlUpdate is called only if MDL_UPDATE is declared with #define.
• mdlDerivatives is called only if MDL_DERIVATIVES is declared with #define.

By inlining an S-function, you can eliminate the calls to these possibly empty functions in the
simulation loop. This can greatly improve the efficiency of the generated code.

To inline an S-function called sfunc_name, you create a custom S-function block target file called
sfunc_name.tlc and place it in the same folder as the S-function MEX-file. Then, at build time, the
target file is executed instead of setting up function calls into the S-function .c file. The S-function
target file “inlines” the S-function by directing the Target Language Compiler to insert only the
statements defined in the target file.

In general, inlining an S-function is especially useful when

• The time required to execute the contents of the S-function is small in comparison to the overhead
required to call the S-function.
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• Certain S-function routines are empty (e.g., mdlUpdate).
• The behavior of the S-function changes between simulation and code generation. For example,

device driver I/O S-functions might read from the MATLAB workspace during simulation, but read
from an actual hardware address in the generated code.

S-Function Parameters
An S-function can write two different types of parameters into the model.rtw file for Target
Language Compiler files to access:

• Parameter settings: These correspond to nontunable parameters (typically set from check boxes
and menus on a masked S-function) that are written via the mdlRTW method of the S-function
using ssWriteRTWParamSettings. The S-function TLC implementation file can then directly
access the values of these parameter settings from the SFcnParamSettings record in the block.

• Tunable parameters: This class of parameters can be accessed when they are registered as run-
time parameters within the S-function. Note that such tunable parameters are automatically
written out to the model.rtw file. Within the TLC file for the S-function, you can access run-time
parameters and their attributes using the LibBlockParameter library function and its variants.

For more information on how to create and use run-time parameters, see “Create and Update S-
Function Run-Time Parameters”. Also see the example sfcndemo_runtime in the S-function
examples for how to create and use the two classes of parameters. The example source files, which
you can inspect and adapt, are

• toolbox/simulink/simdemos/simfeatures/src/sfun_runtime1.c
• toolbox/simulink/simdemos/simfeatures/tlc_c/sfun_runtime1.tlc
• toolbox/simulink/simdemos/simfeatures/src/sfun_runtime2.c
• toolbox/simulink/simdemos/simfeatures/tlc_c/sfun_runtime2.tlc
• toolbox/simulink/simdemos/simfeatures/src/sfun_runtime3.c
• toolbox/simulink/simdemos/simfeatures/tlc_c/sfun_runtime3.tlc

Sample Code for S-Function
Suppose you have a simple S-function that mimics the Gain block, with one input, one output, and a
scalar gain. That is, y = u * p. If the Simulink block’s name is foo and the name of the Level 2 S-
function is foogain, the C MEX S-function must contain this code:

#define S_FUNCTION_NAME foogain
#define S_FUNCTION_LEVEL 2
#include "simstruc.h"
#define GAIN mxGetPr(ssGetSFcnParam(S,0))[0]

static void mdlInitializeSizes(SimStruct *S)
{
  ssSetNumContStates        (S, 0);
  ssSetNumDiscStates        (S, 0);
  
  if (!ssSetNumInputPorts(S, 1)) return;
  ssSetInputPortWidth            (S, 0, 1);
  ssSetInputPortDirectFeedThrough(S, 0, 1);
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  if (!ssSetNumOutputPorts(S, 1)) return;
  ssSetOutputPortWidth          (S, 0, 1);
  
  ssSetNumSFcnParams        (S, 1);
  ssSetNumSampleTimes        (S, 0);  
  ssSetNumIWork        (S, 0);
  ssSetNumRWork        (S, 0);
  ssSetNumPWork        (S, 0);
}
 
static void
mdlOutputs(SimStruct *S, int_T tid)
{
  real_T *y = ssGetOutputPortRealSignal(S, 0);
  const InputRealPtrsType u = ssGetInputPortRealSignalPtrs(S, 0);

  y[0] = (*u)[0] * GAIN;
}

static void
mdlInitializeSampleTimes(SimStruct *S){}

static void
mdlTerminate(SimStruct *S) {}

#define MDL_RTW  /* Change to #undef to remove function */
#if defined(MDL_RTW)&&(defined(MATLAB_MEX_FILE)||defined(NRT))
static void
mdlRTW (SimStruct *S)
{
  if (!ssWriteRTWParameters(S, 1,SSWRITE_VALUE_VECT,"Gain","",
                            mxGetPr(ssGetSFcnParam(S,0)),1)) 
  {
    return;
  }
}
#endif

#ifdef  MATLAB_MEX_FILE
#include "simulink.c" 
#else
#include "cg_sfun.h"
#endif

The following two sections show the difference in the generated code for model.c containing
noninlined and inlined versions of S-function foogain. The model contains no other Simulink blocks.

For more information about these S-function related C library functions, see “Configure C/C++ S-
Function Features”. For information about how to generate code, see “Configure Model and Generate
Code” and “Choose Build Approach and Configure Build Process”.

Comparison of Noninlined and Inlined Versions of model.c

Without a TLC file to define the S-function specifics, the code generator must call the MEX-file S-
function through the S-function API. The following code is the model.c file for the noninlined S-
function (i.e., no corresponding TLC file exists).
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Noninlined S-Function

/*
 * model.c
.
.
.
*/
real_T untitled_RGND = 0.0;             /* real_T ground */
/* Start the model */
void MdlStart(void)
{
  /* (no start code required) */
}
/* Compute block outputs */
void MdlOutputs(int_T tid)
{
  /* Level2 S-Function Block: <Root>/S-Function (foogain) */
  {
    SimStruct *rts = ssGetSFunction(rtS, 0);
    sfcnOutputs(rts, tid);
  }
}
/* Perform model update */
void MdlUpdate(int_T tid)
{
  /* (no update code required) */
}
/* Terminate function */
void MdlTerminate(void)
{
  /* Level2 S-Function Block: <Root>/S-Function (foogain) */
  {
    SimStruct *rts = ssGetSFunction(rtS, 0);
    sfcnTerminate(rts);
  }
}
#include "model_reg.h"
/* [EOF] model.c */

Inlined S-Function

This code is model.c with the foogain S-function fully inlined:

/*
 * model.c
.
.
.
*/
/* Start the model */
void MdlStart(void)
{
  /* (no start code required) */
}

/* Compute block outputs */
void MdlOutputs(int_T tid)
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  /* S-Function block: <Root>/S-Function */
  /* NOTE: There are no calls to the S-function API in the inlined 
     version of model.c. */
  rtB.S_Function = 0.0 * rtP.S_Function_Gain;
}

/* Perform model update */
void MdlUpdate(int_T tid)
{
  /* (no update code required) */
}

/* Terminate function */
void MdlTerminate(void)
{
  /* (no terminate code required) */
}

#include "model_reg.h"

/* [EOF] model.c */

If you include this target file for this S-function block, the resulting model.c code is

rtB.S_Function = 0.0 * rtP.S_Function_Gain;

Including a TLC file drastically decreased the code size and increased the execution efficiency of the
generated code. These notes highlight some information about the TLC code and the generated
output:

• The TLC directive %implements is required by block target files, and must be the first executable
statement in the block target file. This directive prevents the Target Language Compiler from
executing an inappropriate target file for S-function foogain.

• The input to foo is rtGROUND (a Simulink Coder global equal to 0.0) because foo is the only
block in the model and its input is unconnected.

• Including a TLC file for foogain eliminates the need for an S-function registration segment for
foogain. This significantly reduces code size.

• The TLC code inlines the gain parameter when the build process is configured to inline
parameter values. For example, if the S-function parameter is specified as 2.5 in the S-function
dialog box, the TLC Outputs function generates

rtB.foo = input * 2.5;
• Use the %generatefile directive if your operating system has a filename size restriction and the

name of the S-function is foosfunction (that exceeds the limit). In this case, you would include
the following statement in the system target file (anywhere prior to a reference to this S-function
block target file).

%generatefile foosfunction "foosfunc.tlc"

This statement tells the Target Language Compiler to open foosfunc.tlc instead of
foosfunction.tlc.
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Comparison of Noninlined and Inlined Versions of model_reg.h

Inlining a Level 2 S-function significantly reduces the size of the model_reg.h code. Model
registration functions are lengthy; much of the code has been eliminated in this example. The code
below highlights the difference between the noninlined and inlined versions of model_reg.h;
inlining eliminates this code:

/*
 * model_reg.h
 *
*/
/* Normal model initialization code independent of 
      S-functions  */

/* child S-Function registration */
  ssSetNumSFunctions(rtS, 1);

  /* register each child */
  {
    static SimStruct childSFunctions[1];
    static SimStruct *childSFunctionPtrs[1];

    (void)memset((char_T *)&childSFunctions[0], 0, 
                  sizeof(childSFunctions));
    ssSetSFunctions(rtS, &childSFunctionPtrs[0]);
    {
      int_T i;

      for(i = 0; i < 1; i++) {
        ssSetSFunction(rtS, i, &childSFunctions[i]);
      }
    }

    /* Level2 S-Function Block: untitled/<Root>/S-Function 
       (foogain) */
    {
      extern void foogain(SimStruct *rts);
      SimStruct *rts = ssGetSFunction(rtS, 0);

      /* timing info */
      static time_T sfcnPeriod[1];
      static time_T sfcnOffset[1];
      static int_T sfcnTsMap[1];

      {
        int_T i;

        for(i = 0; i < 1; i++) {
          sfcnPeriod[i] = sfcnOffset[i] = 0.0;
        }
      }
      ssSetSampleTimePtr(rts, &sfcnPeriod[0]);
      ssSetOffsetTimePtr(rts, &sfcnOffset[0]);
      ssSetSampleTimeTaskIDPtr(rts, sfcnTsMap);
      ssSetMdlInfoPtr(rts, ssGetMdlInfoPtr(rtS));

      /* inputs */
      {
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        static struct _ssPortInputs inputPortInfo[1];

        _ssSetNumInputPorts(rts, 1);
        ssSetPortInfoForInputs(rts, &inputPortInfo[0]);

        /* port 0 */
        {
          static real_T const *sfcnUPtrs[1];

          sfcnUPtrs[0] = &untitled_RGND;
          ssSetInputPortWidth(rts, 0, 1);
          ssSetInputPortSignalPtrs(rts, 0, 
              (InputPtrsType)&sfcnUPtrs[0]);
        }
      }

      /* outputs */
      {
        static struct _ssPortOutputs outputPortInfo[1];
        _ssSetNumOutputPorts(rts, 1);
        ssSetPortInfoForOutputs(rts, &outputPortInfo[0]);
        ssSetOutputPortWidth(rts, 0, 1);
        ssSetOutputPortSignal(rts, 0, &rtB.S_Function);
      }

      /* path info */
      ssSetModelName(rts, "S-Function");
      ssSetPath(rts, "untitled/S-Function");
      ssSetParentSS(rts, rtS);
      ssSetRootSS(rts, ssGetRootSS(rtS));
      ssSetVersion(rts, SIMSTRUCT_VERSION_LEVEL2);

      /* parameters */
      {
        static mxArray const *sfcnParams[1];

        ssSetSFcnParamsCount(rts, 1);
        ssSetSFcnParamsPtr(rts, &sfcnParams[0]);

        ssSetSFcnParam(rts, 0, &rtP.S_Function_P1Size[0]);
      }

      /* registration */
      foogain(rts);

      sfcnInitializeSizes(rts);
      sfcnInitializeSampleTimes(rts);

      /* adjust sample time */
      ssSetSampleTime(rts, 0, 0.2);
      ssSetOffsetTime(rts, 0, 0.0);
      sfcnTsMap[0] = 0;

      /* Update the InputPortReusable and BufferDstPort flags for 
        each input port */
      ssSetInputPortReusable(rts, 0, 0);
      ssSetInputPortBufferDstPort(rts, 0, -1);
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      /* Update the OutputPortReusable flag of each output port */
    }
  }

A TLC File to Inline S-Function foogain

To avoid unnecessary calls to the S-function and to generate the minimum code required for the S-
function, the following TLC file, foogain.tlc, is provided as an example.

%implements "foogain" "C"

%function Outputs (block, system) Output
  /* %<Type> block: %<Name> */
  %%
  %assign y = LibBlockOutputSignal (0, "", "", 0)
  %assign u = LibBlockInputSignal (0, "", "", 0)
  %assign p = LibBlockParameter (Gain, "", "", 0)
  %<y> = %<u> * %<p>;
%endfunction

Managing Block Instance Data with an Eye Toward Code Generation

Instance data is extra data or working memory that is unique to each instance of a block in a
Simulink model. This does not include parameter or state data (which is stored in the model
parameter and state vectors, respectively), but rather is used to cache intermediate results or derived
representations of parameters and modes. One example of instance data is the buffer used by a
transport delay block.

Allocating and using memory on an instance-by-instance basis can be done several ways in a Level 2
S-function: via ssSetUserData, work vectors (e.g., ssSetRWorkValue, ssSetIWorkValue), or
data-typed work vectors known as DWork vectors. For the smallest effort in writing the S-function and
block target file and for automatic conformance to both static and malloc instance data on targets
such as grt, use data-typed work vectors when writing S-functions with instance data.

The advantages are twofold. In the first place, writing the S-function is more straightforward, in that
memory allocations and frees are handled for you by Simulink. Secondly, the DWork vectors are
written to the model.rtw file for you automatically, including the DWork name, data type, and size.
This makes writing the block target file easier, because you do not have to write TLC code for
allocating and freeing the DWork memory.

Additionally, if you want to bundle groups of DWork vectors into structures for passing to functions,
you can populate the structure with pointers to DWork arrays in both your S-function mdlStart
function and the block target file’s Start method, achieving consistency between the S-function and
the generated code’s handling of data.

Finally, using a DWork makes it straightforward to create a specific version of code (data types, scalar
vs. vectorized, etc.) for each block instance that matches the implementation in the S-function. Both
implementations use DWork in the same way so that the inlined code can be used with the Simulink
Accelerator software without changes to the C MEX S-function or the block target file.

Using Inlined Code with the Simulink Accelerator Software

By default, the Simulink Accelerator software calls your C MEX S-function as part of an accelerated
model simulation. If you prefer to have the accelerator inline your S-function before running the
accelerated model, tell the accelerator to use your block target file to inline the S-function with the
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SS_OPTION_USE_TLC_WITH_ACCELERATOR flag in the call to ssSetOptions() in the
mdlInitializeSizes function of that S-function.

Note that memory and work vector size and usage must be the same for the TLC generated code and
the C MEX S-function, or the Simulink Accelerator software cannot execute the inlined code properly.
This is because the C MEX S-function is called to initialize the block and its work vectors, calling the
mdlInitializeSizes, mdlInitializeConditions, mdlCheckParameters,
mdlProcessParameters, and mdlStart functions. In the case of constant signal propagation,
mdlOutputs is called from the C MEX S-function during the initialization phase of model execution.

During the time-stepping phase of accelerated model execution, the code generated by the Output
and Update block TLC methods will execute, plus the Derivatives and zero-crossing methods if
they exist. The Start method of the block target file is not used in generating code for an
accelerated model.

See Also

Related Examples
• “Write Noninlined S-Function”
• “Write Fully Inlined S-Functions”
• “Write Fully Inlined S-Functions with mdlRTW Routine”
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TLC Coding Conventions
These guidelines can help you apply programming style in each target file consistently.

Begin Identifiers with Uppercase Letters
Identifiers in the file begin with an uppercase letter. For example,

NumModelInputs              1
NumModelOutputs             2
NumNonVirtBlocksInModel     42
DirectFeedthrough           yes
NumContStates               10

Because a Name identifier may be promoted into the parent scope, block records that contain a Name
identifier should start the name with an uppercase letter. For example, a block might contain

Block {
   :
   :
RWork                  [4, 0]
   :
NumRWorkDefines        4
RWorkDefine {
    Name               "TimeStampA"
    Width              1
    StartIndex         0
  }
}

Because the Name identifier within the RWorkDefine record is promoted to PrevT in its parent
scope, it must start with an uppercase letter. The promotion of the Name identifier into the parent
block scope is currently done for the Parameter, RWorkDefine, IWorkDefine, and PWorkDefine
block records.

The Target Language Compiler assignment directive (%assign) generates a warning if you assign a
value to an “unqualified” code generator identifier. For example,

%assign TID = 1

produces an error because the TID identifier is not qualified by Block. However, a “qualified”
assignment does not generate a warning. For example,

%assign Block.TID = 1

does not generate a warning because the assignment contains a qualifier. The Target Language
Compiler therefore assumes that the programmer is intentionally modifying an identifier.

Begin Global Variable Assignments with Uppercase Letters
Global TLC variable assignments should start with uppercase letters. A global variable is a variable
declared in a system target file (grt.tlc, mdlwide.tlc, mdlhdr.tlc, mdlbody.tlc,
mdlreg.tlc, or mdlparam.tlc), or within a function that uses the operator. Global assignments
have the same scope as code generator variables. An example of a global TLC variable defined in
mdlwide.tlc is
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%assign InlineParameters = 1

An example of a global reference in a function is

%function foo() void
  %assign ::GlobalIdx = ::GlobalIdx + 1
%endfunction

Begin Local Variable Assignments with Lowercase Letters
Local TLC variable assignments should start with lowercase letters. A local TLC variable is a variable
assigned inside a function. For example,

%assign numBlockStates = ContStates[0]

Begin Functions Declared in block.tlc Files with Fcn
When you declare a function inside a block.tlc file, it should start with Fcn. For example,

%function FcnMyBlockFunc(...)

Note Functions declared inside a system file are global; functions declared inside a block file are
local.

Do Not Hard-Code Variables Defined in commonsetup.tlc
Because the code generator tracks use of variables and generates code based on usage, you should
use access routines instead of directly using a variable. For example, you should not use the following
in your TLC file:

x = %<tInf>;

You should use

x = %<LibRealNonFinite(inf)>;

Similarly, instead of using %<tTID>, use %<LibTID()>. For a complete list of functions, see TLC
Function Library Reference in “Target Language Compiler”.

Simulink Coder global variables start with rt and Simulink Coder global functions start with rt_.

Avoid naming global variables in modules that start with rt or rt_ because they might conflict with
Simulink Coder global variables and functions. These TLC variables are declared in
commonsetup.tlc.

This convention creates consistent variables throughout the target files. For example, the Gain block
contains the following Outputs function.
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Notes about this TLC code

a. The code section for each block begins with a comment specifying the block type and name.
b. Include a blank line immediately after the end of the function to create consistent spacing

between blocks in the output code.
c. Try to stay within 80 columns per line for the function banner. You might set up an 80 column

comment line at the top of each function. As an example, see constant.tlc.
d. For consistency, use the variables sysIdx and blkIdx for system index and block index,

respectively.
e. Use the variable rollVars when using the %roll construct.
f. When naming loop control variables, use sigIdx and lcv when looping over RollRegions and

xidx and xlcv when looping over the states.

Example: Output function in gain.tlc
%roll sigIdx = RollRegions, lcv = RollThreshold, ... 
       block, "Roller", rollVars

Example: InitializeConditions function in linblock.tlc
%roll xidx = [0:nStates-1], xlcv = RollThreshold,... 
       block, "Roller", rollVars

Conditional Inclusion in Library Files
The Target Language Compiler function library files are conditionally included with guard code so
you can reference them multiple times using %include without worrying if they have previously
been included. Follow this practice for TLC library files that you create.

The convention is to use a variable with the same name as the base filename, uppercase and with
underscores attached at both ends. So, a file named customlib.tlc should have the variable
_CUSTOMLIB_ guarding it.

As an example, the main Target Language Compiler function library, funclib.tlc, contains this TLC
code to prevent multiple inclusion:

%if EXISTS("_FUNCLIB_") == 0
%assign _FUNCLIB_ = 1
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  .
  .
  .
%endif  %% _FUNCLIB_

Code Defensively
As the code your TLC generates could be used in referenced models in unpredictable contexts, do not
assume too much about name spaces. For example, when writing TLC code for a block and adding a
typedef, guard it with if/def, as the following example illustrates:

%openfile tmpBuff
    #ifndef RESOLUTION_TYPEDEF

    typedef enum { LO_RES, HI_RES } Resolution;
    typedef struct { Resolution res; int8_T value; } Data;

    #define RESOLUTION_TYPEDEF
    #endif /* RESOLUTION_TYPEDEF */
  %closefile tmpBuff

  %<LibCacheTypedefs(tmpBuff)>;

See Also

Related Examples
• “Block Target File Methods” on page 21-21
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Block Target File Methods
Block Functions Overview
Each block has a target file that determines what code should be generated for the block. The code
can vary depending on the exact parameters of the block or the types of connections to it (e.g., wide
vs. scalar input).

Within each block target file, block functions specify the code to be output for the block in the
model’s or subsystem’s start function, output function, update function, and so on.

The functions declared inside each of the block target files are called by the system target files. In
these tables, block refers to a Simulink block name (e.g., gain for the Gain block) and system
refers to the subsystem in which the block resides. The first table lists the two functions that are used
for preprocessing and setup. Neither of these functions outputs generated code.

• “BlockInstanceSetup(block, system)” on page 21-21
• “BlockTypeSetup(block, system)” on page 21-22

The following functions generate executable code that the code generator places appropriately:

• “Enable(block, system)” on page 21-23
• “Disable(block, system)” on page 21-23
• “Start(block, system)” on page 21-23
• “InitializeConditions(block, system)” on page 21-24
• “Outputs(block, system)” on page 21-24
• “Update(block, system)” on page 21-25
• “Derivatives(block, system)” on page 21-26
• “Terminate(block, system)” on page 21-26

In object-oriented programming terms, these functions are polymorphic in nature, because each
block target file contains the same functions. The Target Language Compiler dynamically determines
at run-time which block function to execute depending on the block’s type. That is, the system file
only specifies that the Outputs function, for example, is to be executed. The particular Outputs
function is determined by the Target Language Compiler depending on the block’s type.

To write a block target file, use these polymorphic block functions combined with the Target
Language Compiler library functions. For a complete list of the Target Language Compiler library
functions, see TLC Function Library Reference on “Target Language Compiler”.

BlockInstanceSetup(block, system)
The BlockInstanceSetup function executes for the blocks that have this function defined in their
target files in a model. For example, if a model includes 10 From Workspace blocks, then the
BlockInstanceSetup function in fromwks.tlc executes 10 times, once for each From Workspace
block instance. Use BlockInstanceSetup to generate code for each instance of a given block type.

See TLC Function Library Reference on “Target Language Compiler” for available utility processing
functions to call from inside this block function. See the file matlabroot/rtw/c/tlc/blocks/
lookup2d.tlc for an example of the BlockInstanceSetup function.
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Syntax

    BlockInstanceSetup(block, system) void
    block = Reference to a Simulink block
    system = Reference to a nonvirtual Simulink subsystem

This example uses BlockInstanceSetup:

%function BlockInstanceSetup(block, system) void
%if (block.InMask == "yes")
    %assign blockName = LibParentMaskBlockName(block)
  %else
    %assign blockName = LibGetFormattedBlockPath(block)
  %endif
  %if (CodeFormat == "Embedded-C")
    %if !(ParamSettings.ColZeroTechnique == "NormalInterp" && ...
          ParamSettings.RowZeroTechnique == "NormalInterp")
      %selectfile STDOUT

Note: Removing repeated zero values from the X and Y axes will 
produce more efficient code for block: %<blockName>.  To locate 
this block, type

open_system('%<blockName>')

at the MATLAB command prompt.

      %selectfile NULL_FILE
    %endif
  %endif
%endfunction

BlockTypeSetup(block, system)
BlockTypeSetup executes once per block type before code generation begins. That is, if 10 Lookup
Table blocks exist in the model, the BlockTypeSetup function in look_up.tlc is called only one
time. Use this function to perform general work for multiple blocks of a given type.

See TLC Function Library Reference on “Target Language Compiler” for a list of relevant functions to
call from inside this block function. See look_up.tlc for an example of the BlockTypeSetup
function.

Syntax

    BlockTypeSetup(block, system) void
    block = Reference to a Simulink block
    system = Reference to a nonvirtual Simulink subsystem

As an example, given the S-function foo, which requires a #define and two function declarations in
the header file, you could define:

%function BlockTypeSetup(block, system) void

  %% Place a #define in the model's header file

  %openfile buffer
    #define A2D_CHANNEL 0
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  %closefile buffer
           
  %<LibCacheDefine(buffer)>

  %% Place function prototypes in the model's header file

  %openfile buffer
    void start_a2d(void);
    void reset_a2d(void);
  %closefile buffer
           
  %<LibCacheFunctionPrototype(buffer)>
%endfunction

The remaining block functions execute once for each block in the model.

Enable(block, system)
The code generator creates Enable functions for nonvirtual subsystem whenever a Simulink
subsystem contains a block with an Enable function. Including the Enable function in a block’s
target file places the block’s specific enable code in this subsystem Enable function. For example:

%% Function: Enable ============================================
%% Abstract:
%% Subsystem Enable code is required only for the discrete form
%% of the Sine Block. Setting the Boolean to TRUE causes the
%% Output function to resync its last values of cos(wt) and
%% sin(wt).
%%
%function Enable(block, system) Output
  %if LibIsDiscrete(TID)
    /* %<Type> Block: %<Name> */
    %<LibBlockIWork(SystemEnable, "", "", 0)> = (int_T) TRUE;
 
  %endif
%endfunction

Disable(block, system)
Nonvirtual subsystem Disable functions are created whenever a Simulink subsystem contains a
block with a Disable function. Including the Disable function in a block’s target file places the
block’s specific disable code into this subsystem Disable function.

Start(block, system)
Include a Start function to place code in the Start function. The code inside the Start function
executes once and only once. Typically, you include a Start function to execute code once at the
beginning of the simulation (e.g., initialize values in the work vectors) or code that does not need to
be re-executed when the subsystem in which it resides is enabled. See constant.tlc for an
example of the Start function.

%% Function: Start ============================================
%% Abstract:
%% Set the output to the constant parameter value if the block
%% output is visible in the model's start function scope, i.e.,
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%% it is in the global rtB structure.
%%
%function Start(block, system) Output
  %if  LibBlockOutputSignalIsInBlockIO(0)
    /* %<Type> Block: %<Name> */
    %assign rollVars = ["Y", "P"]
    %roll idx = RollRegions, lcv = RollThreshold, block, ...
      "Roller", rollVars
      %assign yr = LibBlockOutputSignal(0,"", lcv, ...
        "%<tRealPart>%<idx>")
      %assign pr = LibBlockParameter(Value, "", lcv, ...
        "%<tRealPart>%<idx>")
      %<yr> = %<pr>;
      %if LibBlockOutputSignalIsComplex(0)
        %assign yi = LibBlockOutputSignal(0, "", lcv, ...
          "%<tImagPart>%<idx>")
        %assign pi = LibBlockParameter(Value, "", lcv, ...
          "%<tImagPart>%<idx>")
        %<yi> = %<pi>;
      %endif
    %endroll  
  %endif
%endfunction %% Start

InitializeConditions(block, system)
TLC code that is generated from the block’s InitializeConditions function appears in one of two
places. A nonvirtual subsystem contains an Initialize function when it is configured to reset states
on enable. In this case, the TLC code generated by this block function is placed in the subsystem
Initialize function, and the start function calls this subsystem Initialize function. If,
however, the Simulink block resides in the root system or in a nonvirtual subsystem that does not
require an Initialize function, the code generated from this block function is placed directly
(inlined) into the start function.

There is a subtle difference between the block functions Start and InitializeConditions.
Typically, you include a Start function to execute code that does not need to re-execute when the
subsystem in which it resides is enabled. You include an InitializeConditions function to
execute code that must re-execute when the subsystem in which it resides is enabled. For example:

%% Function: InitializeConditions =============================
%%
%% Abstract: Invalidate the stored output and input in 
%% rwork[1 2*blockWidth] by setting the time stamp stored 
%% in rwork[0]) to rtInf.
%%
%function InitializeConditions(block, system) Output
  /* %<Type> Block: %<Name> */
  %<LibBlockRWork(PrevT, "", "", 0)> = %<LibRealNonFinite(inf)>;
%endfunction

Outputs(block, system)
A block should generally include an Outputs function. The TLC code generated by a block’s
Outputs function is placed in one of two places. The code is placed directly in the model’s Outputs
function if the block does not reside in a nonvirtual subsystem, and in a subsystem’s Outputs
function if the block resides in a nonvirtual subsystem. For example:
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%% Function: Outputs ==========================================
%% Abstract:
%%      Y[i] = fabs(U[i]) if U[i] is real or
%%      Y[i] = sqrt(U[i].re^2 + U[i].im^2) if U[i] is complex.
%%
%function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %%
  %assign inputIsComplex = LibBlockInputSignalIsComplex(0)
  %assign RT_SQUARE = "RT_SQUARE"
  %%
  %assign rollVars = ["U", "Y"]
  %if inputIsComplex
    %roll sigIdx = RollRegions, lcv = RollThreshold, ...
      block, "Roller", rollVars
      %%
      %assign ur = LibBlockInputSignal( 0, "", lcv, ...
        "%<tRealPart>%<sigIdx>")
      %assign ui = LibBlockInputSignal( 0, "", lcv, ...
        "%<tImagPart>%<sigIdx>")
      %%
      %assign y = LibBlockOutputSignal(0, "", lcv, sigIdx)
      %<y> = sqrt( %<RT_SQUARE>( %<ur> ) + %<RT_SQUARE>( %<ui> ) );
    %endroll
  %else
    %roll sigIdx = RollRegions, lcv = RollThreshold, ...
      block, "Roller", rollVars
      %assign u = LibBlockInputSignal (0, "", lcv, sigIdx)
      %assign y = LibBlockOutputSignal(0, "", lcv, sigIdx)
      %<y> = fabs(%<u>);
    %endroll
  %endif
  %endfunction

Note Zero-crossing reset code is placed in the Outputs function.

If you write TLC code to generate inlined code from an S-function, and if the TLC code contains an
Outputs function, you must modify the TLC code if all of these conditions are true:

• An output port uses or inherits constant sample time. The output port has a constant value.
• The S-function is a multirate S-function or uses port-based sample times.

In this case, the TLC code must generate code for the constant-valued output port by using the
function OutputsForTID instead of the function Outputs. For more information, see “Specifying
Constant Sample Time (Inf) for a Port”.

Update(block, system)
Include an Update function if the block has code that needs to be updated at each major time step.
Code generated from this function is placed in either the model’s or the subsystem’s Update
function, depending on whether or not the block resides in a nonvirtual subsystem. For example:

%% Function: Update ============================================
%% Abstract:
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%%      X[i] = U[i]
%%
%function Update(block, system) Output
  /* %<Type> Block: %<Name> */
  %assign rollVars = ["U", "Xd"] 
  %roll idx = RollRegions, lcv = RollThreshold, block, ... 
    "Roller", rollVars 
    %assign u = LibBlockInputSignal(0, "", lcv, idx) 
    %assign x = LibBlockDiscreteState("", lcv, idx) 
    %<x> = %<u>;
  %endroll
%endfunction %% Update

Derivatives(block, system)
Include a Derivatives function when generating code to compute the block’s continuous states.
Code generated from this function is placed in either the model’s or the subsystem’s Derivatives
function, depending on whether or not the block resides in a nonvirtual subsystem. See
integrat.tlc for an example of the Derivatives function.

Terminate(block, system)
Include a Terminate function to place code in MdlTerminate. User-defined S-function target files
can use this function to save data, free memory, reset hardware on the target, and so on. See
tofile.tlc for an example of the Terminate function.

See Also

Related Examples
• “Loop Rolling” on page 21-27

21 Inlining S-Functions

21-26



Loop Rolling
One of the optimization features of the Target Language Compiler is the intrinsic support for loop
rolling. Based on a specified threshold, code generation for looping operations can be unrolled or left
as a loop (rolled).

Coupled with loop rolling is the concept of noncontiguous signals. Consider the following model:

The input to the timestwo S-function comes from two arrays located at two different memory
locations, one for the output of source1 and one for the output of block source2. This is because of
an optimization that makes the Mux block virtual, meaning that code is not explicitly generated for
the Mux block and thus processor cycles are not spent evaluating it (i.e., it becomes a pure graphical
convenience for the block diagram). So this is represented in the model.rtw file in this case as

Block {
      Type              "S-Function"
      MaskType              "S-function: timestwo"
      BlockIdx              [0, 0, 2]
      SL_BlockIdx          2
      GrSrc              [0, 1]
      ExprCommentInfo {
    SysIdxList        []
    BlkIdxList        []
    PortIdxList        []
      }
      ExprCommentSrcIdx {
    SysIdx            -1
    BlkIdx            -1
    PortIdx            -1
      }
      Name              "<Root>/timestwo  C-MEX S-Function"
      SLName              "<Root>/timestwo \nC-MEX S-Function"
      Identifier          timestwoCMEXSFunction
      TID              0
      RollRegions          [0:19, 20:49]
      NumDataInputPorts          1
      DataInputPort {
    SignalSrc        [b0@20, b1@30]
    SignalOffset        [0:19, 0:29]
    Width            50
    RollRegions        [0:19, 20:49]
      }
      NumDataOutputPorts      1
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      DataOutputPort {
    SignalSrc        [b2@50]
    SignalOffset        [0:49]
    Width            50
      }
      Connections {
    InputPortContiguous    [no]
    InputPortConnected    [yes]
    OutputPortConnected    [yes]
    OutputPortBeingMerged    [no]
    DirectSrcConn        [no]
    DirectDstConn        [yes]
    DataOutputPort {
      NumConnPoints          1
      ConnPoint {
        SrcSignal            [0, 50]
        DstBlockAndPortEl        [0, 4, 0, 0]
      }
    }
  }
.
.
.

From this fragment of the model.rtw file you can see that the block and input port RollRegion
entries are not just one number, but two groups of numbers. This denotes two groupings in memory
for the input signal. The generated code looks like this:

/* S-Function Block: <Root>/timestwo  C-MEX S-Function */
  /* Multiply input by two */
  {
    int_T i1;

    const real_T *u0 = &contig_sample_B.u[0];
    real_T *y0 = contig_sample_B.timestwoCMEXSFunction_m;

    for (i1=0; i1 < 20; i1++) {
      y0[i1] = u0[i1] * 2.0;
    }

    u0 = &contig_sample_B.u_o[0];
    y0 = &contig_sample_B.timestwoCMEXSFunction_m[20];

    for (i1=0; i1 < 30; i1++) {
      y0[i1] = u0[i1] * 2.0;
    }
}

Notice that two loops are generated and between them the input signal is redirected from the first
base address, &contig_sample_B.u[0], to the second base address of the signals,
&contig_sample_B.u_o[0]. If you do not want to support this in your S-function or your generated
code, you can use

ssSetInputPortRequiredContiguous(S, 1);

in the mdlInitializeSizes function to cause Simulink to implicitly generate code that performs a
buffering operation. This option uses both extra memory and CPU cycles at run-time, but might be
worth it if your algorithm performance increases enough to offset the overhead of the buffering.
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Use the %roll directive to generate loops. See also “%roll” on page 19-22 for the reference entry for
%roll, and “Input Signal Functions” on page 22-7 for a discussion on the behavior of %roll.

Related Examples
• “Target Language Compiler Directives” on page 19-2
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TLC Function Library Reference

This chapter provides a set of Target Language Compiler functions that are useful for inlining S-
functions. The TLC files contain many other library functions, but you should use only the functions
that are documented in these reference pages for development. Undocumented functions can change
significantly from release to release. “Obsolete Functions” on page 22-69 includes a table of
obsolete functions and their replacements.

• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
• “Input Signal Functions” on page 22-7
• “Output Signal Functions” on page 22-17
• “Parameter Functions” on page 22-23
• “Block State and Work Vector Functions” on page 22-28
• “Block Path and Error Reporting Functions” on page 22-32
• “Code Configuration Functions” on page 22-34
• “Sample Time Functions” on page 22-53
• “Miscellaneous Functions” on page 22-61
• “Advanced Functions” on page 22-71
• “Block Compatibility Functions” on page 22-76
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Target Language Compiler Library Functions Overview
There are several library functions that provide access to block inputs, outputs, parameters, sample
times, and other information. It is recommended that you use these library functions to access many
of the parameter name/parameter values pairs in the block record, as opposed to accessing the
parameter name/parameter value pairs directly from your block TLC code.

The library functions simplify block TLC code and provide support for loop rolling, data types, and
complex data. The functions also provide a layer to protect against changes that can occur to the
contents of the model.rtw file.

An exception to using these functions is when you access parameter settings for a block. Parameter
settings can be written out using the mdlRTW function of a C MEX S-function. They can contain data
in the form of strings, scalar values, vectors, and matrices. They can be used to pass fixed values and
information that is used to alter the generated code for a block or directly as values in the resulting
code of a block. For more information about this exception, see “Exception to Using the Library
Functions that Access model.rtw” on page 18-11.

See Also

More About
• “Target Language Compiler Function Conventions” on page 22-3
• “Input Signal Functions” on page 22-7
• “Output Signal Functions” on page 22-17
• “Parameter Functions” on page 22-23
• “Block State and Work Vector Functions” on page 22-28
• “Block Path and Error Reporting Functions” on page 22-32
• “Code Configuration Functions” on page 22-34
• “Sample Time Functions” on page 22-53
• “Miscellaneous Functions” on page 22-61
• “Advanced Functions” on page 22-71
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Target Language Compiler Function Conventions
You can find examples using these functions in matlabroot/toolbox/simulink/blocks/tlc_c
and matlabroot/toolbox/simulink/simdemos/simfeatures/tlc_c. The corresponding MEX
S-function source code is located in matlabroot/simulink/src or matlabroot/toolbox/
simulink/simdemos/simfeatures/src. MATLAB file S-functions and the MEX-file executables
(for example, sfunction.mex*) are located in matlabroot/toolbox/simulink/blocks or
matlabroot/toolbox/simulink/simdemos/simfeatures.

Common Function Arguments
Several functions take similar or identical arguments. To simplify the reference pages, some of these
arguments are documented in detail here instead of in the reference pages.

Argument Description
portIdx Refers to an input or output port index, starting at 0. For example, the first input port

of an S-function is 0.
ucv User control variable. This is an advanced feature that overrides the lcv and sigIdx

parameters. When used within an inlined S-function, it should generally be specified as
"".

lcv Loop control variable. This is generally generated by the %roll directive via the
second %roll argument (e.g., lcv=RollThreshold) and should be passed directly to
the library function. It contains either "", indicating that the current pass through the
%roll is being inlined, or it is the name of a loop control variable such as "i",
indicating that the current pass through the %roll is being placed in a loop. Outside
the %roll directive, this is usually specified as "".
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Argument Description
sigIdxoridx Signal index. Sometimes referred to as the signal element index. When accessing

specific elements of an input or output signal directly, the call to the various library
routines should have ucv="", lcv="", and sigIdx equal to the desired integer signal
index starting at 0. For complex signals, sigIdx can be an overloaded integer index
specifying both whether the real or imaginary part is being accessed and which
element. When you access these items inside a %roll, use the sigIdx generated by
the %roll directive.

Most functions that take a sigIdx argument accept it in an overloaded form, where
sigIdx can be

• An integer, e.g., 3. If the referenced signal is complex, then this refers to the
identifier for the complex container. If the referenced signal is not complex, then
this refers to the identifier.

• An id-num, usually of the form (see “Overloading sigIdx” on page 22-4)

a "%<tRealPart>%<idx>" (e.g., "re3"). The real part of the signal element.
Usually "%<tRealPart>%<sigIdx>" when sigIdx is generated by the %roll
directive.

b "%<tImagPart>%<idx>" (e.g., "im3"). The imaginary part of the signal
element or "" if the signal is not complex. Usually "%<tImagPart>
%<sigIdx>" when sigIdx is generated by the %roll directive.

Use the idx name when referring to a state or work vector.

Functions that accept the three arguments ucv, lcv, sigIdx (or idx) are called
differently depending upon whether or not they are used within a %roll directive. If
they are used within a %roll directive, ucv is generally specified as "" and, lcv and
sigIdx are the same as those specified in the %roll directive. If they are not used
within a %roll directive, ucv and lcv are generally specified as "", and sigIdx
specifies the index to access.

paramIdx Parameter index. Sometimes referred to as the parameter element index. The handling
of this parameter is very similar to sigIdx above: it can be #, re#, or im#.

stateIdx State index. Sometimes referred to as the state vector element index. It must evaluate
to an integer where the first element starts at 0.

Overloading sigIdx
The signal index (sigIdx sometimes written as idx) can be overloaded when passed to most library
functions. Suppose you are interested in element 3 of a signal, and ucv="", lcv="". The following
table shows

• Values of sigIdx
• Whether the signal being referenced is complex
• What the function that uses sigIdx returns
• An example of a returned variable
• Data type of the returned variable
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Note that “container” in the following table refers to the object that encapsulates both the real and
imaginary parts of the number, e.g., creal_T, defined in tmwtypes.h.

sigIdx Complex Function Returns Example Data
Type

"re3" Yes Real part of element 3 u0[2].re real_T
"im3" Yes Imaginary part of element

3
u0[2].im real_T

"3" Yes Complex container of
element 3

u0[2] creal_T

3 Yes Complex container of
element 3

u0[2] creal_T

"re3" No Element 3 u0[2] real_T
"im3" No "" N/A N/A
"3" No Element 3 u0[2] real_T
3 No Element 3 u0[2] real_T

Now suppose the following:

1 You are interested in element 3 of a signal.
2 (ucv = "i" AND lcv == "") OR (ucv = "" AND lcv = "i").

The following table shows values of idx, whether the signal is complex, and what the function that
uses idx returns.

sigIdx Complex Function Returns
"re3" Yes Real part of element i
"im3" Yes Imaginary part of element ii
"3" Yes Complex container of element i
3 Yes Complex container of element i
"re3" No Element i
"im3" No ""
"3" No Element i
3 No Element i

Notes

• The vector index is added only for wide signals.
• If ucv is not an empty string (""), then ucv is used instead of sigIdx in the above examples and

both lcv and sigIdx are ignored.
• If ucv is empty but lcv is not empty, then the function returns "&y%<portIdx>[%<lcv>]" and

sigIdx is ignored.
• It is assumed that the roller has declared and initialized the variables accessed inside the roller.

The variables accessed inside the roller should be specified using rollVars as the argument to
the %roll directive.
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See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
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Input Signal Functions

LibBlockInputHasSymbolicWidth(portIdx)
Returns 1 (true) if the specified block input port index has symbolic dimensions. This function take
the port index as an input argument.

See LibBlockInputHasSymbolicWidth in blkio_api.tlc.

LibBlockInputPortIndexMode(block, pidx)
Purpose

Determines the index mode of a block's input port.

Arguments

block — Block record

pidx — Port index

Returns

"" for a nonindex port, and "Zero-based" or "One-based" otherwise.

Description

If an input port of a block is set as an index port and its indexing base is marked as zero-based or
one-based, this information is written into the model.rtw file. LibBlockInputPortIndexMode
queries the indexing base to branch to different code according to what the input port indexing base
is.

Example

%if LibBlockInputPortIndexMode(block, pidx) == "Zero-based"
  ...
%elseif LibBlockInputPortIndexMode(block, pidx) == "One-based"
  ...
%else
  ...
%endif

See LibBlockInputPortIndexMode in blkiolib.tlc.

LibBlockInputPortIsContinuousQuantity(portIdx)
Returns whether the input port accepts a co-simulation signal. This function takes the port index as
an input argument.

See LibBlockInputPortIsContinuousQuantity in blkio_api.tlc.
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LibBlockInputSignal(portIdx, ucv, lcv, sigIdx)
Based on the input port number (portIdx), the user control variable (ucv), the loop control variable
(lcv), the signal index (sigIdx), and where this input signal is coming from,
LibBlockInputSignal returns the reference to a block input signal.

The returned string value is a valid rvalue (right-side value) for an expression. The block input
signal can come from another block, a state vector, or an external input, or it can be a literal constant
(e.g., 5.0).

Note Do not use LibBlockInputSignal to access the address of an input signal.

Because the returned value can be a literal constant, you should not use LibBlockInputSignal to
access the address of an input signal. To access the address of an input signal, use
LibBlockInputSignalAddr. Accessing the address of the signal via LibBlockInputSignal can
result in a reference to a literal constant (e.g., 5.0).

For example, the following would not work.

%assign u = LibBlockInputSignal(0, "", lcv, sigIdx)
x = &%<u>;

If %<u> refers to an invariant signal with a value of 4.95, the statement (after being processed by the
preprocessor) would be generated as

x = &4.95;

or, if the input signal sources to ground, the statement could come out as

x = &0.0;

Neither of these would compile.

Avoid such situations by using LibBlockInputSignalAddr.

%assign uAddr = LibBlockInputSignalAddr(0, "", lcv, sigIdx)
x = %<uAddr>;

The code generator tracks signals and parameters accessed by their addresses and declares them in
addressable memory.

Input Arguments

The following table summarizes the input arguments to LibBlockInputSignal.
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LibBlockInputSignal Arguments

Argument Description
portIdx Integer specifying the input port index (zero-based).

Note: For certain built-in blocks, portIdx can be a string identifying the port
(such as "enable" or "trigger").

ucv User control variable. Must be a string, either an indexing expression or "".
lcv Loop control variable. Must be a string, either an indexing expression or "".
sigIdx Either an integer literal or a string of the form

%<tRealPart>Integer
%<tImagPart>Integer

For example, the following signifies the real part of the signal and the
imaginary part of the signal starting at 5:

"%<tRealPart>5"
"%<tImagPart>5"

General Usage

Uses of LibBlockInputSignal fall into the categories described below.

Direct indexing

If ucv == "" and lcv == "", LibBlockInputSignal returns an indexing expression for the
element specified by sigIdx.

Loop rolling/unrolling

In this case, lcv and sigIdx are generated by the %roll directive, and ucv must be "". A nonempty
value for lcv is allowed only when generated by the %roll directive and when using the Roller TLC
file (or a user supplied Roller TLC file that conforms to the same variable/signal offset handling). In
addition, calls to LibBlockInputSignal with lcv should occur only when "U" or a specific input
port (e.g., "u0") is passed to the %roll directive via the roll variables argument.

The following example shows a single input/single output port S-function.

%assign rollVars  = ["U", "Y", "P"]
%roll sigIdx=RollRegions, lcv=RollThreshold, block, ...
    "Roller", rollVars
  %assign u = LibBlockInputSignal( 0, "", lcv, sigIdx)
  %assign y = LibBlockOutputSignal(0, "", lcv, sigIdx)
  %assign p = LibBlockParameter(   0, "", lcv, sigIdx)
  %<y> = %<p> * %<u>;
%endroll

With the %roll directive, sigIdx is the starting index of the current roll region and lcv is "" or an
indexing variable. The following are examples of valid values:

LibBlockInputSignal(0, "", lcv, sigIdx)    rtB.blockname[0]

LibBlockInputSignal(0, "", lcv, sigIdx)    u[i]
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In the first example, LibBlockInputSignal returns rtB.blockname[2] when the input port is
connected to the output of another block, and

• The loop control variable (lcv) generated by the %roll directive is empty, indicating that the
current roll region is below the roll threshold, and sigIdx is 0.

• The width of the input port is 1, indicating that this port is being scalar expanded.

If sigIdx is nonzero, then rtB.blockname[sigIdx] is returned. For example, if sigIdx is 3,
then rtB.blockname[3] is returned.

In the second example, LibBlockInputSignal returns u[i] when the current roll region is above
the roll threshold and the input port width is nonscalar (wide). In this case, the Roller TLC file sets up
a local variable, u, to point to the input signal, and the code in the current %roll directive is placed
within a for loop.

For another example, consider a block with multiple input ports where each port has a width greater
than or equal to 1 and at least one port has width equal to 1. The following code sets the output
signal to the sum of the squares of the input signals.

%assign y = LibBlockOutputSignal(0, "", "", 0)
%<y> = 0;

%assign rollVars = ["U"]
%foreach port = block.NumDataInputPorts - 1
  %roll sigIdx=RollRegions, lcv = RollThreshold, block, ...
    "Roller", rollVars
  %assign u = LibBlockInputSignal(port, "", lcv, sigIdx)
  %<y> += %<u> * %<u>;
  %endroll
%endforeach

Because the first parameter of LibBlockInputSignal is 0 indexed, you must index the foreach
loop to start from 0 and end at NumDataInputPorts-1.
User Control Variable (ucv) Handling

This is an advanced mode and generally not required by S-function authors.

If ucv != "", LibBlockInputSignal returns an rvalue for the input signal using the user control
variable indexing expression. The control variable indexing expression has the following form:

rvalue_id[%<ucv>]%<optional_real_or_imag_part>

To obtain rvalue_id, look at the integer part of sigIdx. You must specify sigIdx because the input
to this block can be discontinuous, meaning that the input can come from several different memory
areas (signal sources) and sigIdx is used to identify the area of interest for the ucv. You can also
use sigIdx to determine whether the real or imaginary part of a signal is to be accessed.

You can obtain optional_real_or_imag_part from the string part of sigIdx (i.e., "re", or "im",
or "").

Note that the value for lcv is ignored and sigIdx must point to the same element in the input signal
to which the ucv initially points.

The handling of ucv with LibBlockInputSignal requires care. Consider a discontinuous input
signal feeding an input port as in the following block diagram:
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To use ucv in a robust manner, you must use the %roll directive with a roll threshold of 1 and a
Roller TLC file that does not have loop header/trailer setup for this input signal. In addition, you need
to use ROLL_ITERATIONS to determine the width of the current roll region, as in the following TLC
code:

{
int i;

%assign rollVars  = [""]
%assign threshold = 1
  %roll sigIdx=RollRegions, lcv=threshold, block, ...
    "FlatRoller", rollVars
  %assign u = LibBlockInputSignal( 0, "i", "", sigIdx)
  %assign y = LibBlockOutputSignal(0, "i+%<sigIdx>", "", sigIdx)
  %assign p = LibBlockParameter( 0, "i+%<sigIdx>", "", sigIdx)
  for (i = 0; i < %<ROLL_ITERATIONS()>; i++) {
    %<y> = %<p> * %<u>;
  }
%endroll
}

Note that the FlatRoller does not have loop header/trailer setup (rollVars is ignored). Its
purpose is to walk the RollRegions of the block. Alternatively, you can force a contiguous input
signal to your block by specifying

ssSetInputPortRequiredContiguous(S, port, TRUE)

in your S-function.

In this case, the TLC code simplifies to

{
%assign u = LibBlockInputSignal( 0, "i", "", 0)
%assign y = LibBlockOutputSignal(0, "i", "", 0)
%assign p = LibBlockParameter(   0, "i", "", 0)

for (i = 0; i < %<LibBlockInputSignalWidth(0)>; i++) {
  %<y> = %<p> * %<u>;
  }
}

If you create your own roller and the indexing does not conform to the way the Roller TLC file
provided by MathWorks operates, then must to use ucv instead of lcv.

 Input Signal Functions

22-11



Handling Input Arguments: ucv, lcv, and sigIdx

Consider the following cases:

Function (Case 1, 2, 3,4) Example Return Value
LibBlockInputSignal(0, "i", "", sigIdx) rtB.blockname[i]
LibBlockInputSignal(0, "i", "", sigIdx) rtU.signame[i]
LibBlockInputSignal(0, "", lcv, sigIdx) u0[i1]
LibBlockInputSignal(0, "", lcv, sigIdx) rtB.blockname[0]

The value returned depends on what the input signal is connected to in the block diagram and how
the function is invoked (e.g., in a %roll or directly). In the above example,

• Cases 1 and 2 occur when an explicit call is made with the ucv set to "i".

Case 1 occurs when sigIdx points to the block I/O vector, i.e., the first element that "i" starts
with. For example, if you initialize "i" to be starting at offset 5, then you should specify sigIdx
== 5.

Case 2 occurs when sigIdx points to the external input vector, i.e., the first element that "i"
starts with. For example, if you initialize "i" to start at offset 20, then you should specify sigIdx
== 20.

• Cases 3 and 4 receive the same arguments, lcv and sigIdx; however, they produce different
return values.

Case 3 occurs when LibBlockInputSignal is called within a %roll directive and the current
roll region is being rolled (lcv != "").

Case 4 occurs when LibBlockInputSignal is called within a %roll directive and the current
roll region is not being rolled (lcv == "").

When called within a%roll directive, LibBlockInputSignal looks at ucv, lcv, and sigIdx, the
current roll region, and the current roll threshold to determine the return value. The variable ucv has
highest precedence, lcv has the next highest precedence, and sigIdx has the lowest precedence.
That is, if ucv is specified, it is used (thus, when called in a %roll directive it is usually ""). If ucv is
not specified, and if lcv and sigIdx are specified, the returned value depends on whether or not the
current roll region is being placed in a for loop or being expanded. If the roll region is being placed
in a loop, then lcv is used; otherwise, sigIdx is used.

A direct call to LibBlockInputSignal (inside or outside a %roll directive) uses sigIdx when ucv
and lcv are specified as "".

For an example of LibBlockInputSignal, see sfun_multiport.tlc.

See also blkiolib.tlc.

LibBlockInputSignalAddr(portIdx, ucv, lcv, sigIdx)
Returns a string that provides the memory address of the specified block input port signal.

When you need an input signal address, you must use LibBlockInputSignalAddr instead of
appending an “&” to the string returned by LibBlockInputSignal. For example,
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LibBlockInputSignal can return a literal constant, such as 5 (i.e., an invariant input signal). The
code generator tracks when LibBlockInputSignalAddr is called on an invariant signal and
declares the signal as const data (which is addressable), instead of being placed as a literal constant
in the generated code (which is not addressable).

Note that the last input argument, sigIdx, is not overloaded, which it is in LibBlockInputSignal.
Hence, if the input signal is complex, the address of the complex container is returned.

Example

To get the address of a wide input signal and pass it to a user function for processing, you could use

%assign uAddr = LibBlockInputSignalAddr(0, "", "", 0) 
%assign y = LibBlockOutputSignal(0, "", "", 0)
%<y> = myfcn(%<uAddr>);

See LibBlockInputSignalAddr in blkiolib.tlc.

LibBlockInputSignalAliasedThruDataTypeName(portIdx, reim)
Returns the name of the aliased thru data type (e.g., int_T, ... creal_T) corresponding to the
specified block input port. Specify the reim argument as "" (empty) if you want the complete signal
type name.

For example, if reim == "" and the first output port is real and complex, the data type name placed
in dtname is creal_T.

%assign dtname = LibBlockInputSignalDataTypeName(0,"")

Specify reim as tRealPart if you want the raw element type name. For example, if reim ==
tRealPart and the first output port is real and complex, the data type name returned is real_T.

%assign dtname = LibBlockOutputSignalDataTypeName(0,tRealPart)

See LibBlockInputSignalAliasedThruDataTypeName in blkiolib.tlc.

LibBlockInputSignalAllowScalarExpandedExpr(block,portIdx)
Allow the input signal to be an expression, even when an output signal is wide. This function takes
the block record and the port index as input arguments. Call this function from within the
BlockInstanceSetup function.

See LibBlockInputSignalAllowScalarExpandedExpr in blkio_api.tlc.

LibBlockInputSignalASCIIEscapedUnitExpr(portIdx)
Returns the escaped name of the units corresponding to the specified block input port. This function
takes the port index as an input argument.

See LibBlockInputSignalASCIIEscapedUnitExpr in blkio_api.tlc.
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LibBlockInputSignalConnected(portIdx)
Returns 1 if the specified input port is connected to a block other than the Ground block and 0
otherwise.

See LibBlockInputSignalConnected inblkio_api.tlc .

LibBlockInputSignalDataTypeId(portIdx)
Returns the numeric identifier (id) corresponding to the data type of the specified block input port.

If the input port signal is complex, LibBlockInputSignalDataTypeId returns the data type of the
real part (or the imaginary part) of the signal.

See LibBlockInputSignalDataTypeId in blkiolib.tlc.

LibBlockInputSignalDataTypeName(portIdx, reim)
Returns the name of the data type (e.g., int_T, ... creal_T) corresponding to the specified block
input port.

Specify the reim argument as "" if you want the complete signal type name. For example, if
reim=="" and the first output port is real and complex, the data type name placed in dtname is
creal_T.

%assign dtname = LibBlockInputSignalDataTypeName(0,"")

Specify the reim argument as tRealPart if you want the raw element type name. For example, if
reim==tRealPart and the first output port is real and complex, the data type name returned is
real_T.

%assign dtname = LibBlockInputSignalDataTypeName(0,tRealPart)

See LibBlockInputSignalDataTypeName in blkiolib.tlc.

LibBlockInputSignalDimensions(portIdx)
Returns the dimensions vector of the specified block input port, e.g., [2,3].

See LibBlockInputSignalDimensions in blkio_api.tlc.

LibBlockInputSignalIsComplex(portIdx)
Returns 1 if the specified block input port is complex, 0 otherwise.

See LibBlockInputSignalIsComplex in blkio_api.tlc.

LibBlockInputSignalIsExpr(portIdx)
Returns 1 (true) if the input signal is an expression (versus a variable), and 0 (false) otherwise. This
function takes the port index as an input argument.

See LibBlockInputSignalIsExpr in blkio_api.tlc.
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LibBlockInputSignalIsFrameData(portIdx)
Returns 1 if the specified block input port is frame based, 0 otherwise.

See LibBlockInputSignalIsFrameData in blkio_api.tlc.

LibBlockInputSignalIsTrivialExpr(portIdx)
Returns 1 (true) if the input signal is a trivial expression (versus a variable), and 0 (false) otherwise.
This function take the port index as an input argument.

See LibBlockInputSignalIsTrivialExpr in blkio_api.tlc.

LibBlockInputSignalLocalSampleTimeIndex(portIdx)
Returns the local sample time index corresponding to the specified block input port.

See LibBlockInputSignalLocalSampleTimeIndex in blkiolib.tlc.

LibBlockInputSignalNumDimensions(portIdx)
Returns the number of dimensions of the specified block input port.

See LibBlockInputSignalNumDimensions in blkio_api.tlc.

LibBlockInputSignalOffsetTime(portIdx)
Returns the offset time corresponding to the specified block input port.

See LibBlockInputSignalOffsetTime in blkiolib.tlc.

LibBlockInputSignalSampleTime(portIdx)
Returns the sample time corresponding to the specified block input port.

See LibBlockInputSignalSampleTime in blkiolib.tlc.

LibBlockInputSignalSampleTimeIndex(portIdx)
Returns the sample time index corresponding to the specified block input port.

See LibBlockInputSignalSampleTimeIndex in blkiolib.tlc.

LibBlockInputSignalSymbolicDimensions(portIdx)
Returns the number of dimensions of the specified block input port.

See LibBlockInputSignalSymbolicDimensions(portIdx) in blkiolib.tlc.
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LibBlockInputSignalSymbolicWidth(portIdx)
Returns the symbolic width of the specified block input port.

See LibBlockInputSignalSymbolicWidth(portIdx) in blkiolib.tlc.

LibBlockInputSignalWidth(portIdx)
Returns the width of the specified block input port index.

See LibBlockInputSignalWidth in blkio_api.tlc.

LibBlockInputSignalUnitExpr(portIdx)
Returns the name of the units corresponding to the specified block input port. This function takes the
port index as an input argument.

See LibBlockInputSignalUnitExpr in blkio_api.tlc.

LibBlockInputSignalUnitId(portIdx)
Returns the numeric identifier (id) corresponding to the units of the specified block input port. This
function takes the port index as an input argument.

See LibBlockInputSignalUnitId in blkio_api.tlc.

See also LibBlockInputSignalUnitExp and LibBlockOutputSignalUnitId in
blkio_api.tlc.

LibBlockNumInputPorts(block)
Returns the number of data input ports of a block (excludes control ports).

See LibBlockNumInputPorts in blocklib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Output Signal Functions

LibBlockAssignOutputSignal(portIdx, ucv, lcv, sigIdx, rhs)
Based on the output port number (portIdx), the user control variable (ucv), the loop control
variable (lcv), the signal index (sigIdx), and the output signal destination,
LibBlockAssignOutputSignal assigns a block’s output to a specified right hand side value, (rhs).

See LibBlockAssignOutputSignal in customstoragelib.tlc.

LibBlockGetNumFcnCallOutputs(block)
Returns the number of function call outputs for the specified block. This function takes the block
record as an input argument.

See LibBlockGetNumFcnCallOutputs in block_api.tlc.

LibBlockGetNumFcnCallOutputsDsts(block)
Returns the number of function call output destinations for the specified block. This function takes
the block record as an input argument.

See LibBlockGetNumFcnCallOutputDsts in block_api.tlc.

LibBlockNumOutputPorts(block)
Returns the number of data output ports of a block (excludes control and state ports).

See LibBlockNumOutputPorts in blocklib.tlc.

LibBlockOutputHasSymbolicWidth(portIdx)
Returns 1 (true) if the specified block ouput port index has symbolic dimensions, and 0 (false)
otherwise. This function takes the port index as an input argument.

See LibBlockOutputHasSymbolicWidth in blkio_api.tlc.

LibBlockOutputPortIndexMode(block, pidx)
Purpose

Determines the index mode of a block's output port.

Description

If a block's output port is set as an index port and its indexing base is marked as zero-based or one-
based, this information is written into the model.rtw file. LibBlockOutputPortIndexMode
queries the indexing base to branch to different code according to what the output port indexing base
is.
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Example
%if LibBlockOutputPortIndexMode(block, idx) == "Zero-based"
  ...
%elseif LibBlockOutputPortIndexMode(block, idx) == "One-based"
  ...
%else
  ...
%endif

Arguments

block — Block record

pidx — Port index

Returns

"" for a nonindex port, and "Zero-based" or "One-based" otherwise.

See LibBlockOutputPortIndexMode in blkiolib.tlc.

LibBlockOutputPortIsContinuousQuantity(portIdx)
Returns whether the output port represents a co-simulation signal. This function takes the port index
as an input argument.

See LibBlockOutputPortIsContinuousQuantity in blkio_api.tlc.

LibBlockOutputSignal(portIdx, ucv, lcv, sigIdx)
Based on the output port number (portIdx), the user control variable (ucv), the loop control
variable (lcv), the signal index (sigIdx), and the output signal destination,
LibBlockOutputSignal returns a reference to a block output signal.

The returned value is a valid lvalue (left-side value) for an expression. The block output destination
can be a location in the block I/O vector (another block's input), the state vector, or an external
output.

Note Do not use LibBlockOutputSignal to access the address of an output signal.

The code generator tracks when a variable (e.g., a signal or parameter) is accessed by its address. To
access the address of an output signal, use LibBlockOutputSignalAddr as in the following
example:

%assign yAddr = LibBlockOutputSignalAddr(0, "", lcv, sigIdx)
x = %<yAddr>;

See LibBlockOutputSignal in blkiolib.tlc.

LibBlockOutputSignalAddr(portIdx, ucv, lcv, sigIdx)
Returns a string that provides the memory address of the specified block output port signal.
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When an output signal address is required, you must use LibBlockOutputSignalAddr instead of
taking the address that is returned by LibBlockOutputSignal. For example,
LibBlockOutputSignal can return a literal constant, such as 5 (i.e., an invariant output signal).
When LibBlockOutputSignalAddr is called on an invariant signal, the signal is declared as a
const instead of being placed as a literal constant in the generated code.

Note that unlike LibBlockOutputSignal, the last argument, sigIdx, is not overloaded. Hence, if
the output signal is complex, the address of the complex container is returned.

Example

To get the address of a wide output signal and pass it to a user function for processing, you could use

%assign u = LibBlockOutputSignalAddr(0, "", "", 0)
%assign y = LibBlockOutputSignal(0, "", "", 0)
%<y> = myfcn (%<u>);

See LibBlockOutputSignalAddr in blkiolib.tlc.

LibBlockOutputSignalAliasedThruDataTypeName(portIdx, reim)
Returns the type name string (e.g., int_T, ... creal_T) of the aliased data type corresponding to
the specified block output port.

Specify the reim argument as "" if you want the complete signal type name. For example, if reim
== "" and the first output port is real and complex, the data type placed in dtname is creal_T:
%assign dtname = LibBlockOutputSignalAliasedThroughDataTypeName(0x,"")

Specify the reim argument as tRealPart if you want the raw element type name. For example, if
reim == tRealPart and the first output port is real and complex, the data type name returned is
real_T.
%assign dtname = LibBlockOutputSignalAliasedThroughDataTypeName(0,tRealPart)

See LibBlockOutputSignalAliasedThruDataTypeName in blkiolib.tlc.

LibBlockOutputSignalBeingMerged(portIdx)
Returns whether the specified output port is connected to a Merge block.

See LibBlockOutputSignalBeingMerged in blkio_api.tlc.

LibBlockOutputSignalConnected(portIdx)
Returns 1 if the specified output port is connected to a block other than the Ground block and 0
otherwise.

See LibBlockOutputSignalConnected in blkio_api.tlc.

LibBlockOutputSignalDataTypeId(portIdx)

Returns the numeric ID corresponding to the data type of the specified block output port.
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If the output port signal is complex, LibBlockOutputSignalDataTypeId returns the data type of
the real (or the imaginary) part of the signal.

See LibBlockOutputSignalDataTypeId in blkiolib.tlc.

LibBlockOutputSignalDataTypeName(portIdx, reim)
Returns the type name string (e.g., int_T, ... creal_T) of the data type corresponding to the
specified block output port.

Specify the reim argument as "" if you want the complete signal type name. For example, if
reim=="" and the first output port is real and complex, the data type name placed in dtname is
creal_T.

%assign dtname = LibBlockOutputSignalDataTypeName(0x,"")

Specify the reim argument as tRealPart if you want the raw element type name. For example, if
reim==tRealPart and the first output port is real and complex, the data type name returned is
real_T.

%assign dtname = LibBlockOutputSignalDataTypeName(0,tRealPart)

See LibBlockOutputSignalDataTypeName in blkiolib.tlc.

LibBlockOutputSignalDimensions(portIdx)
Returns the dimensions of the specified block output port.

See LibBlockOutputSignalDimensions in blkio_api.tlc.

LibBlockOutputSignalIsComplex(portldx)
Returns 1 if the specified block output port is complex, 0 otherwise.

See LibBlockOutputSignalIsComplex in blkio_api.tlc.

LibBlockOutputSignalIsConstExpr(portIdx)
Returns 1 (true) if the output signal is a constant expression, and 0 (false) otherwise. Note that a
constant expression is constant even if a block output function calls it. This function takes the port
index as an input argument.

See LibBlockOutputSignalIsConstExpr in blkio_api.tlc.

LibBlockOutputSignalIsExpr(portldx)
Returns 1 (true) if the output signal is an expression, and 0 (false) otherwise.

See LibBlockOutputSignalIsExpr in blkio_api.tlc.
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LibBlockOutputSignalIsExprInOutputs(portIdx)
Returns 1 (true) if the output signal is an expression in the outputs function, and 0 (false) otherwise.
You can use this function as a low-level utility to get access to what the value will be when generating
the block's output code. Use this function in the BlockInstanceSetup function. This function takes
the port index as an input argument.

See LibBlockOutputSignalIsExprInOutputs in blkio_api.tlc.

LibBlockOutputSignalIsFrameData(portIdx)
Returns 1 if the specified block output port is frame based, 0 otherwise.

See LibBlockOutputSignalIsFrameData in blkio_api.tlc.

LibBlockOutputSignalIsNonConstExpr(portIdx)
Returns 1 (true) if the output signal is an non-constant expression, and 0 (false) otherwise. This
function takes the port index as an input argument.

See LibBlockOutputSignalIsNonConstExpr in blkio_api.tlc.

LibBlockOutputSignalIsTrivialExpr(portIdx)
Returns 1 (true) if the output signal is a trivial expression, and 0 (false) otherwise. This function takes
the port index as an input argument.

See LibBlockOutputSignalIsTrivialExpr in blkio_api.tlc.

LibBlockOutputSignalLocalSampleTimeIndex(portIdx)
Returns the local sample time index corresponding to the specified block output port.

See LibBlockOutputSignalLocalSampleTimeIndex in blkio_api.tlc.

LibBlockOutputSignalNumDimensions(portIdx)
Returns the number of dimensions of the specified block output port.

See LibBlockOutputSignalNumDimensions in blkio_api.tlc.

LibBlockOutputSignalOffsetTime(portIdx)
Returns the offset time corresponding to the specified block output port.

See LibBlockOutputSignalOffsetTime in blkiolib.tlc.

LibBlockOutputSignalSampleTime(portIdx)
Returns the sample time corresponding to the specified block output port.
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See LibBlockOutputSignalSampleTime in blkiolib.tlc.

LibBlockOutputSignalSampleTimeIndex(portIdx)
Returns the sample time index corresponding to the specified block output port.

See LibBlockOutputSignalSampleTimeIndex in blkiolib.tlc.

LibBlockOutputSignalSymbolicDimensions(portIdx)
Returns the symbolic dimensions of specified block output port.

See LibBlockOutputSignalSymbolicDimensions in blkiolib.tlc.

LibBlockOutputSignalSymbolicWidth(portIdx)
Returns the symbolic width of specified block output port.

See LibBlockOutputSignalSymbolicWidth in blkiolib.tlc.

LibBlockOutputSignalWidth(portIdx)
Returns the width of the specified block output port.

See LibBlockOutputSignalWidth in blkio_api.tlc.

LibBlockOutputSignalUnitExpr(portIdx)
Returns the type name string of the units corresponding to the specified output port. This function
takes the port index as an input argument.

See LibBlockOutputSignalUnitExpr in blkio_api.tlc.

LibBlockOutputSignalUnitId(portIdx)
Returns the numeric ID corresponding to the units of the specified block output port. This function
takes the port index as an input argument.

See LibBlockOutputSignalUnitId in blkio_api.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Parameter Functions
LibBlockMatrixParameter
LibBlockMatrixParameter(param, rucv, rlcv, ridx, cucv, clcv, cidx) returns a
matrix parameter for a block, given the row and column user control variables (rucv, cucv), loop
control variables (rlcv, clcv), and indices (ridx, cidx). Generally, blocks should use
LibBlockParameter. If you have a matrix parameter, you should write it as a column-major vector
and access it via LibBlockParameter.

Note Loop rolling is currently not supported, and will generate an error if requested (i.e., if either
rlcv or clcv is not equal to "").

The row and column index arguments are similar to the arguments for LibBlockParameter. The
column index (cidx) is overloaded to handle complex numbers.

See LibBlockMatrixParameter in paramlib.tlc.

LibBlockMatrixParameterAddr
LibBlockMatrixParameterAddr(param, rucv, rlcv, ridx, cucv, clcv, cidx) returns
the address of a matrix parameter.

Note LibBlockMatrixParameterAddr returns the address of a matrix parameter. Loop rolling is
not supported (i.e., rlcv and clcv should both be an empty string).

See LibBlockMatrixParameterAddr in paramlib.tlc.

LibBlockMatrixParameterBaseAddr
LibBlockMatrixParameterBaseAddr(param) returns the base address of a matrix parameter.

See LibBlockMatrixParameterBaseAddr in paramlib.tlc.

LibBlockParamSetting

LibBlockParamSetting(bType, psType) returns the string of a specified parameter setting for a
specified block type. If you pass an empty block type into this function, the parameter setting will be
assumed to be in the ParamSettings record of the block. If a nonempty block type is passed into the
function, the parameter settings will be assumed to be in the %<Btype>ParamSettings record of
that block.

See LibBlockParamSetting in paramlib.tlc.

LibBlockParameter
Based on the parameter reference (param), the user control variable (ucv), the loop control variable
(lcv), the signal index (sigIdx), and the state of parameter inlining, LibBlockParameter(param,
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ucv, lcv, sigIdx) returns a reference to a block parameter. The returned value is a valid rvalue
(right-side value for an expression). For example,

Case Function Call Can Produce
1 LibBlockParameter(Gain, "i", lcv, sigIdx) rtP.blockname[i]
2 LibBlockParameter(Gain, "i", lcv, sigIdx) rtP.blockname
3 LibBlockParameter(Gain, "", lcv, sigIdx) p_Gain[i]
4 LibBlockParameter(Gain, "", lcv, sigIdx) p_Gain
5 LibBlockParameter(Gain, "", lcv, sigIdx) 4.55
6 LibBlockParameter(Gain, "", lcv, sigIdx) rtP.blockname.re
7 LibBlockParameter(Gain, "", lcv, sigIdx) rtP.blockname.im

To illustrate the basic workings of LibBlockParameter, assume a noncomplex vector signal where
Gain[0]=4.55:

LibBlockParameter(Gain, "", "i", 0)

Case Rolling Inline
Parameter

Type Result Required in
Memory

1 0 Yes Scalar 4.55 No
2 1 Yes Scalar 4.55 No
3 0 Yes Vector 4.55 No
4 1 Yes Vector p_Gain[i] Yes
5 0 No Scalar rtP.blk.Gain No
6 0 No Scalar rtP.blk.Gain No
7 0 No Vector rtP.blk.prm[0] No
8 0 No Vector p.Gain[i] Yes

Note Case 4. Even though Inline Parameter is Yes, the parameter must be placed in memory (RAM),
because it is accessed inside a for loop.

Note LibBlockParameter also supports expressions when used with inlined parameters and
parameter tuning.

For example, if the parameter field had the MATLAB expression '2*a', LibBlockParameter would
return the C expression '(2*a)'. The list of functions supported by LibBlockParameter is
determined by the functions FcnConvertNodeToExpr and FcnConvertIdToFcn. To enhance
functionality, augment or update either of these functions.

Note that certain types of expressions are not supported, such as x*y where both x and y are
nonscalar expressions.

See the documentation about tunable parameters for more details on the exact functions and syntax
that are supported.

22 TLC Function Library Reference

22-24



Warning

Do not use LibBlockParameter to access the address of a parameter, or you may might erroneously
reference a number (i.e., &4.55) when the parameter is inlined. You can avoid this situation by using
LibBlockParameterAddr.

See LibBlockParameter in paramlib.tlc.

LibBlockParameterAddr
LibBlockParameterAddr(param, ucv, lcv, idx) returns the address of a block parameter.

Using LibBlockParameterAddr to access a parameter when the global InlineParams variable is
equal to 1 will cause the variable to be declared const in RAM instead of being inlined.

Accessing the address of an expression when the expression has multiple tunable/rolled variables in it
will result in an error.

See LibBlockParameterAddr in paramlib.tlc.

LibBlockParameterBaseAddr
LibBlockParameterBaseAddr(param) returns the base address of a block parameter.

Using LibBlockParameterBaseAddr to access a parameter when the global InlineParams
variable is equal to one will cause the variable to be declared const in RAM instead of being inlined.

Accessing the address of an expression when the expression has multiple tunable/rolled variables in it
will result in an error.

See LibBlockParameterBaseAddr in paramlib.tlc.

LibBlockParameterDataTypeId
LibBlockParameterDataTypeId(param) returns the numeric ID corresponding to the data type
of the specified block parameter.

See LibBlockParameterDataTypeId in paramlib.tlc.

LibBlockParameterDataTypeName
LibBlockParameterDataTypeName(param, reim) returns the name of the data type
corresponding to the specified block parameter.

See LibBlockParameterDataTypeName in paramlib.tlc.

LibBlockParameterDimensions

LibBlockParameterDimensions(param) returns a row vector of length N (where N >= 1) giving
the dimensions of the parameter data.
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For example,

%assign dims  = LibBlockParameterDimensions("paramName")
%assign nDims = SIZE(dims,1)
%foreach i=nDims
   /* Dimension %<i+1> = %<dims[i]> */
%endforeach

LibBlockParameterDimensions differs from LibBlockParameterSize in that it returns the
dimensions of the parameter data prior to collapsing the Matrix parameter to a column-major vector.
The collapsing occurs for run-time parameters that have specified their outputAsMatrix field as
False.

See LibBlockParameterDimensions in paramlib.tlc.

LibBlockParameterIsComplex

LibBlockParameterIsComplex(param) returns 1 if the specified block parameter is complex, 0
otherwise.

See LibBlockParameterIsComplex in paramlib.tlc.

LibBlockParameterSize
LibBlockParameterSize(param) returns a vector of size 2 in the format [nRows, nCols] where
nRows is the number of rows and nCols is the number of columns.

See LibBlockParameterSize in paramlib.tlc.

LibBlockParameterString
Based on the block parameter reference (param), LibBlockParameterString(param) returns the
specified block parameter interpreted as a string, for example, this function returns:

• STRINGOF(param.Value[0]) if the parameter is a row matrix
• STRINGOF(param.Value) otherwise

Note It is an error to invoke this function with a matrix-valued parameter with more than one row.

If you are only accessing a parameter value using LibBlockParameterValue or
LibBlockParameterString, consider converting the parameter from Tunable to Nontunable. Then,
use ssWriteRTWParamSettings to write the value of the parameter to the model.rtw file. Inlining
parameters reduces RAM usage because the code generator uses the numerical values of parameters,
instead of their symbolic names, in the generated code.

See LibBlockParameterString in paramlib.tlc.

LibBlockParameterValue
Based on the block parameter reference (param) and the index element of the array (elidx),
LibBlockParameterValue(param, elIdx) returns the numeric value of a parameter. You can use
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the LibBlockParameterWidth(param) function to get the width of the array and then use elidx
(valid values of 0 to width-1) to get a particular element of the array.

If you are only accessing a parameter value using LibBlockParameterValue or
LibBlockParameterString, consider converting the parameter from Tunable to Nontunable. Then,
use ssWriteRTWParamSettings to write the value of the parameter to the model.rtw file. Inlining
parameters reduces RAM usage because the code generator uses the numerical values of parameters,
instead of their symbolic names, in the generated code.

Example

If you want to generate code for a different integrator depending on a parameter for a block, you can
use the following:

%assign mode = LibBlockParameterValue(Integrator, 0)
%switch (mode)
   %case 1
      %<CodeForIntegrator1>
      %break
   %case 2
      %<CodeForIntegrator2>
      %break
   %default
      Error: Unrecognized integrator value.
      %break
%endswitch

See LibBlockParameterValue in paramlib.tlc.

LibBlockParameterWidth
LibBlockParameterWidth(param) returns the number of elements (width) of a parameter.

See LibBlockParameterWidth in paramlib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Block State and Work Vector Functions

LibBlockAssignDWork(dwork, ucv, lcv, sigIdx, rhs)
Based on the block’s dwork index or record (dwork), the user control variable (ucv), the loop control
variable (lcv), and the signal index (sigIdx), LibBlockAssignDWork assigns a block’s dwork to a
specified right hand side value (rhs).

See LibBlockAssignDWork in customstoragelib.tlc.

LibBlockContinuousState(ucv, lcv, idx)
Returns a string corresponding to the specified block continuous state (CSTATE) element.

See LibBlockContinuousState in blocklib.tlc.

LibBlockContinuousStateDerivative(ucv, lcv, idx)
Returns a string corresponding to the specified block continuous state (CSTATE) element.

See also LibBlockDiscreteState.

See LibBlockContinuousStateDerivative in blocklib.tlc.

LibBlockContStateDisabled(ucv, lcv, idx)
Returns a string corresponding to the specified block continuous state (CSTATE) element.

See also LibBlockDiscreteState.

See LibBlockContStateDisabled in blocklib.tlc.

LibBlockDWork(dwork, ucv, lcv, idx)
Returns a string corresponding to the specified block dwork element. The last input argument is
overloaded to handle complex dworks.

idx = "re3" — Returns the real part of element 3 if dwork is complex, otherwise returns element
3.

idx = "im3" — Returns the imaginary part of element 3 if dwork is complex, otherwise returns "".

idx = "3" — Returns the complex container of element 3 if dwork is complex, otherwise returns
element 3.

If either ucv or lcv is specified (i.e., it is not equal to "") then the index part of the last input
argument (sigIdx) is ignored.

See LibBlockDWork in blocklib.tlc.
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LibBlockDWorkAddr(dwork, ucv, lcv, idx)
Returns a string corresponding to the address of the specified block dwork element.

See LibBlockDWorkAddr in blocklib.tlc.

LibBlockDWorkDataTypeId(dwork)
Returns the data type ID of the specified block dwork.

See LibBlockDWorkDataTypeId in blocklib.tlc.

LibBlockDWorkDataTypeName(dwork, reim)
Returns the data type name of the specified block dwork.

See LibBlockDWorkDataTypeName in blocklib.tlc.

LibBlockDWorkIsComplex(dwork)
Returns 1 if the specified block dworkis complex. Returns 0 otherwise.

See LibBlockDWorkIsComplex in blocklib.tlc.

LibBlockDWorkName(dwork)
Returns the name of the specified block dwork.

See LibBlockDWorkName in blocklib.tlc.

LibBlockDWorkStorageClass(dwork)
Returns the storage class of the specified block dwork.

See LibBlockDWorkStorageClass in blocklib.tlc.

LibBlockDWorkStorageTypeQualifier(dwork)
Returns the storage type qualifier of the specified block dwork.

See LibBlockDWorkStorageTypeQualifier in blocklib.tlc.

LibBlockDWorkUsedAsDiscreteState(dwork)
Returns 1 if the specified block dwork is used as a discrete state, returns 0 otherwise.

See LibBlockDWorkUsedAsDiscreteState in blocklib.tlc.
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LibBlockDWorkWidth(dwork)
Returns the width of the specified block dwork.

See LibBlockDWorkWidth in blocklib.tlc.

LibBlockDiscreteState(ucv, lcv, idx)
Returns a string corresponding to the specified block discrete state (DSTATE) element.

See LibBlockDiscreteState in blocklib.tlc.

LibBlockIWork(definediwork, ucv, lcv, idx)
Returns a string corresponding to the specified block IWORK element. See LibBlockRWork.

See LibBlockIWork in blocklib.tlc.

LibBlockMode(ucv, lcv, idx)
Returns a string corresponding to the specified block MODE element.

See LibBlockMode in blocklib.tlc.

LibBlockNonSampledZC(ucv, lcv, NSZCIdx)
Returns a string corresponding to the specified block NSZC.

LibBlockNonSampledZC returns an element for the nonsampled zero-crossing state based on ucv,
lcv, and NSZCIdx.

Arguments

ucv — User control variable string

lcv — Loop control variable string

NSZCIdx — Nonsampled zero-crossing index

See LibBlockNonSampledZC in blocklib.tlc.

LibBlockPWork(definedpwork, ucv, lcv, idx)
Returns a string corresponding to the specified block PWORK element. See LibBlockRWork.

See LibBlockPWork in blocklib.tlc.

LibBlockRWork(definedrwork, ucv, lcv, idx)

Returns a string corresponding to the specified block RWORK element. The first argument,
definedrwork, is a symbol defined in the mdlRTW routine of the C MEX file with code like:
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ssWriteRTWWorkVect([...], "RWork", [...], "MyRWorkName", [...])

Alternatively, if RWork defines have not been made, definedrwork is ignored and the raw RWork
vector is accessed. In this case, uses in a loop rolling context are disallowed.

See LibBlockRWork in blocklib.tlc.

LibBlockZCSignalValue(ucv, lcv, zcsIdx, zcElIdx)
Purpose

Returns a string corresponding to the specified block ZCSignalValue

Arguments

ucv
User control variable string.

lcv
Loop control variable string.

zcsIdx
zc signal Idx

zcElIdx
Idx of zc signal element in the zc signal

Description

LibBlockZCSignalValue returns an element for the zero crossing state based on ucv, lcv, and
zcsIdx.

See LibBlockZCSignalValue in blocklib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Block Path and Error Reporting Functions

LibBlockReportError(block, errorstring)
Use LibBlockReportError when reporting errors for a block. LibBlockReportError is designed
to be used from block target files (e.g., the TLC file for an inlined S-function).

LibBlockReportError can be called with or without the block record scoped. To call the function
without a block record scoped, pass the block record. To call the function when the block is scoped,
pass block = [].

LibBlockReportError([],"error string")
  -- If block is scoped
LibBlockReportError(blockrecord,"error string")
  -- If block record is available

See LibBlockReportError in utillib.tlc.

LibBlockReportFatalError(block, errorstring)
Use LibBlockReportFatalError when reporting fatal (assert) errors for a block. Use
LibBlockReportFatalError for defensive programming. Refer to “Generating Errors from TLC
Files” on page A-2.

See LibBlockReportFatalError in utillib.tlc.

LibBlockReportWarning(block, warnstring)
Use LibBlockReportWarning when reporting warnings for a block. LibBlockReportWarning is
designed to be used from block target files (e.g., the TLC file for an inlined S-function).

LibBlockReportWarning can be called with or without the block record scoped. To call this
function without a block record scoped, pass the block record. To call this function when the block is
scoped, pass block = [].

LibBlockReportWarning([],"warn string")
--    If block is scoped
LibBlockReportWarning(blockrecord,"warn string)
--    If block record is available

See LibBlockReportWarning in utillib.tlc.

LibGetBlockName(block)
LibGetBlockName returns the short block path name string for a block record, excluding carriage
returns and other special characters that can be present in the name.

See LibGetBlockName in utillib.tlc.
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LibGetBlockPath(block)
LibGetBlockPath returns the full block path name string for a block record, including carriage
returns and other special characters that can be present in the name. Currently, the only other
special string sequences defined are '/*' and '*/'.

The full block path name string is useful when you are accessing blocks from MATLAB. For example,
you can use the full block name with hilite_system via FEVAL to match the Simulink path name
exactly.

Use LibGetFormattedBlockPath to get a block path suitable for placing in a comment or error
message.

See LibGetBlockPath in utillib.tlc.

LibGetFormattedBlockPath(block)
LibGetFormattedBlockPath returns the full path name string of a block without special
characters. The string returned from LibGetFormattedBlockPath is suitable for placing the block
name, in comments or generated code, on a single line.

Currently, the special characters are carriage returns, '/*', and '*/'. A carriage return is
converted to a space, '/*' is converted to '/+', and '*/' is converted to '+/'. Note that a '/' in
the name is automatically converted to a '//' to distinguish it from a path separator.

Use LibGetBlockPath to get the block path for MATLAB functions used in reference blocks in your
model.

See LibGetFormattedBlockPath in utillib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Code Configuration Functions
LibAddSourceFileCustomSection(file, builtInSection, newSection)
Adds a custom section to a source file. You must associate a custom section with one of the built-in
sections: Includes, Defines, Types, Enums, Definitions, Declarations, Functions, or Documentation.
Nothing happens if the section already exists, except to report an error if a inconsistent built-in
section association is attempted. LibAddSourceFileCustomSection is available only with the
Embedded Coder product.

Arguments

file — Source file reference

builtInSection — Name of the associated built-in section

newSection — Name of the new (custom) section

See LibAddSourceFileCustomSection in codetemplatelib.tlc.

LibAddToCommonIncludes(incFileName)
Adds items to a list of #include /package specification items. Each member of the list is unique.
Attempting to add a duplicate member does nothing.

LibAddToCommonIncludes should be called from block TLC methods to specify generation of
#include statements in model.h. Specify the names of files on the include path inside angle
brackets, e.g., <sysinclude.h>. Specify the names of local files without angle brackets, e.g.,
myinclude.h. Each call to LibAddToCommonIncludes adds the specified file to the list only if it is
not already there. Filenames with and without angle brackets (e.g., <math.h> and math.h) are
considered different. The #include statements are placed inside model.h.

Example
LibAddToCommonIncludes("tpu332lib.h")

See LibAddToCommonIncludes in cachelib.tlc.

LibAddToModelSources(newFile)
LibAddToModelSources serves two purposes:

• To notify the build process that it must build with the specified source file
• To update the SOURCES: file1.c file2.c ... comment in the generated code.

For inlined S-functions, LibAddToModelSources is generally called from BlockTypeSetup.
LibAddToModelSources adds a filename to the list of sources for building this model.
LibAddToModelSources returns 1 if the filename passed in was a duplicate (i.e., it was already in
the sources list) and 0 if it was not a duplicate.

You can use the LibAddToModelSources function for other purposes in TLC aside from writing S-
functions. If you write your own S-functions, use the SFunctionModules block parameter instead of
LibAddToModelSources. See LibAddToModelSources in utillib.tlc.
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LibCacheDefine(buffer)
Each call to LibCacheDefine appends your buffer to the existing cache buffer. For blocks,
LibCacheDefine is generally called from BlockTypeSetup.

LibCacheDefine caches #define statements for inclusion in model_private.h or model.c. Call
LibCacheDefine from inside BlockTypeSetup to cache a #define statement. Each call to
LibCacheDefine appends your buffer to the existing cache buffer. The #define statements are
placed inside model_private.h or model.c.

Example

%openfile buffer
#define INTERP(x,x1,x2,y1,y2) ( y1+((y2 - y1)/(x2 - x1))*(x-x1))
#define this that
%closefile buffer
%<LibCacheDefine(buffer)>

See LibCacheDefine in cachelib.tlc.

LibCacheExtern(buffer)
LibCacheExtern should be called from inside BlockTypeSetup to cache an extern statement.
Each call to LibCacheExtern appends your buffer to the existing cache buffer. The extern
statements are placed in model_private.h.

Example

%openfile buffer
 extern real_T mydata;
%closefile buffer
%<LibCacheExtern(buffer)>

See LibCacheExtern in cachelib.tlc.

LibCacheFunctionPrototype(buffer)
LibCacheFunctionPrototype should be called from inside BlockTypeSetup to cache a function
prototype. Each call to LibCacheFunctionPrototype appends your buffer to the existing cache
buffer. The prototypes are placed inside model_private.h.

Example

%openfile buffer
 extern int_T fun1(real_T x);
 extern real_T fun2(real_T y, int_T i);
%closefile buffer
%<LibCacheFunctionPrototype(buffer)>

See LibCacheFunctionPrototype in cachelib.tlc.
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LibCacheTypedefs(buffer)
LibCacheTypedefs should be called from inside BlockTypeSetup to cache typedef declarations.
Each call to LibCacheTypedefs appends your buffer to the existing cache buffer. The typedef
statements are placed inside model.h (or model_common.h).

Example
%openfile buffer
typedef foo bar;
%closefile buffer
%<LibCacheTypedefs(buffer)>

See LibCacheTypedefs in cachelib.tlc.

LibCallModelInitialize()
Returns code for calling the model's initialize function (valid for ERT only).

See LibCallModelInitialize in codetemplatelib.tlc.

LibCallModelStep(tid)
Returns code for calling the model's step function (valid for ERT only).

See LibCallModelStep in codetemplatelib.tlc.

LibCallModelTerminate()
Returns code for calling the model's terminate function (valid for ERT only).

See LibCallModelTerminate in codetemplatelib.tlc.

LibCallSetEventForThisBaseStep(buffername)
Returns code for calling the model's set events function (valid for ERT only).

Argument

buffername — Name of the variable used to buffer the events. For the example ert_main.c, this is
eventFlags.

See LibCallSetEventForThisBaseStep in codetemplatelib.tlc.

LibClearFileSectionContents(fileIdx, attrib)
Before writing file to disk, clear file sections with custom values.

Arguments

fileIdx (scope or number) — File index

attrib (string) — Name of model attribute
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See LibGetSourceFileAttribute in codetemplatelib.tlc.

LibCreateSourceFile(type, creator, name)
Creates a new C or C++ file and returns its reference. If the file already exists,
LibCreateSourceFile returns the existing file's reference.

Syntax

%assign fileH = LibCreateSourceFile
                ("Source", "Custom", "foofile")

Arguments

type (string) — Valid values are "Source" and "Header" for .c and .h files, respectively.

creator (string) — Who is creating the file? An error is reported if different creators attempt to
create the same file.

name (string) — Base name of the file (i.e., without the extension). Note that files are not written to
disk if they are empty.

Returns

Reference to the model file (scope).

See LibCreateSourceFile in codetemplatelib.tlc.

LibGetFileRecordName (file)
Returns model file name (including the path) without the file extension. To retrieve the file name
(including the path) with the file extension, use LibGetSourceFileSection.

Arguments

file — Source file reference

See LibGetFileRecordName in codetemplatelib.tlc.

LibGetMdlPrvHdrBaseName()
Returns the base name of the model's private header file, for example, model_private.h.

See LibGetMdlPrvHdrBaseName in codetemplatelib.tlc.

LibGetMdlPubHdrBaseName()
Returns the base name of the model's public header file, for example, model.h.

See LibGetMdlPubHdrBaseName in codetemplatelib.tlc.
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LibGetMdlSrcBaseName()
Returns the base name of the model's main source file, for example, model.c.

See LibGetMdlSrcBaseName in codetemplatelib.tlc.

LibGetMdlDataSrcBaseName()
Returns the base name of the model's data file, for example, model_data.c.

See LibGetMdlDataSrcBaseName in codetemplatelib.tlc.

LibGetMdlTypesHdrBaseName()
Returns the base name of the model types file, for example, model_types.h.

See LibGetMdlTypesHdrBaseName in codetemplatelib.tlc.

LibGetMdlCapiHdrBaseName()
Returns the base name of the model capi header file, for example, model_capi.h.

See LibGetMdlCapiHdrBaseName in codetemplatelib.tlc.

LibGetMdlCapiSrcBaseName()
Returns the base name of the model capi source file, for example, model_capi.c.

See LibGetMdlCapiSrcBaseName in codetemplatelib.tlc.

LibGetMdlCapiHostHdrBaseName()
Returns the base name of the model capi host header file, for example, model_host_capi.h.

See LibGetMdlCapiHostHdrBaseName in codetemplatelib.tlc.

LibGetMdlTestIfHdrBaseName()
Returns the base name of the model testinterface header file, for example,
model_testinterface.h.

See LibGetMdlTestIfHdrBaseName in codetemplatelib.tlc.

LibGetMdlTestIfSrcBaseName()
Returns the base name of the model testinterface source file, for example,
model_testinterface.c.

See LibGetMdlTestIfSrcBaseName in codetemplatelib.tlc.
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LibGetDataTypeTransHdrBaseName()
Returns the base name of the data type transition file, for example, model_dt.h for code
generation's Real-Time and Embedded-C code formats.

See LibGetDataTypeTransHdrBaseName in codetemplatelib.tlc.

LibGetModelDotCFile()
Returns a reference to the model.c or .cpp source file. You can then cache additional code using
LibSetSourceFileSection.

Syntax

%assign srcFile = LibGetModelDotCFile()
%<LibSetSourceFileSection(srcFile, "Functions", mybuf)>

Returns

Returns a reference to the model.c or .cpp source file.

See LibGetModelDotCFile in codetemplatelib.tlc.

LibGetModelDotHFile()
Returns a reference to the model.h source file. You can then cache additional code using
LibSetSourceFileSection.

Syntax

%assign hdrFile = LibGetModelDotHFile()
%<LibSetSourceFileSection(hdrFile, "Functions", mybuf)>

Returns

Returns a reference to the model.h source file.

See LibGetModelDotHFile in codetemplatelib.tlc.

LibGetModelName()
Returns the name of the model (without an extension).

See LibGetModelName in codetemplatelib.tlc.

LibGetNumSourceFiles()
Returns the number of source files (.c or .cpp and .h) that have been created.

Syntax

%assign numFiles = LibGetNumSourceFiles()
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Returns

Returns the number of files (number).

See LibGetNumSourceFiles in codetemplatelib.tlc.

LibGetRTModelErrorStatus()
Returns the code required to get the model error status.

Syntax
%<LibGetRTModelErrorStatus()>;

See LibGetRTModelErrorStatus in codetemplatelib.tlc.

LibGetSourceFileAttribute(fileIdx, attrib)
Returns the specified attribute of a file. The table lists the valid attributes.

Attribute
Name (with file
extension)

SystemsInFile IsEmpty SharedType

BaseName RequiredIncludes Indent CodeTemplate
Type UtilityIncludes WrittenToDisk OutputDirectory
Creator Filter Shared Group

Arguments

fileIdx (scope or number) — File index

attrib (string) — Name of model attribute

See LibGetSourceFileAttribute in codetemplatelib.tlc.

LibGetSourceFileFromIdx(fileIdx)
Returns a model file reference based on its index. This reference can be useful for a common
operation on all files, for example, to set the leading file banner of all files.

Syntax
%assign fileH = LibGetSourceFileFromIdx(fileIdx)

Argument

fileIdx (number) — Index of model file

Returns

Reference (scope) to the model file.

See LibGetSourceFileFromIdx in codetemplatelib.tlc.
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LibGetSourceFileSection(fileIdx, section)
Returns the contents of a file. See “LibSetSourceFileSection(fileH, section, value)” on page 22-44 for
a list of valid sections.

Arguments

fileIdx (scope or number) — File index

section (string) — File section of interest

See LibGetSourceFileSection in codetemplatelib.tlc.

LibGetSourceFileTag(fileIdx)
Returns fileName_h and fileName_c for header and source files, respectively, where fileName is
the name of the model file.

Syntax

%assign tag = LibGetSourceFileTag(fileIdx)

Argument

fileIndex (number) — File index

Returns

Returns the tag (string).

See LibGetSourceFileTag in codetemplatelib.tlc.

LibMdlRegCustomCode(buffer, location)
Places declaration statements and executable code inside the model_initialize function.

Arguments

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

See LibMdlRegCustomCode in hookslib.tlc.
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LibMdlStartCustomCode(buffer, location)
Places declaration statements and executable code inside the start function. Start code is executed
once, during the model initialization phase.

Syntax
LibMdlStartCustomCode(buffer, location)

Arguments

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibMdlStartCustomCode places declaration statements and executable code inside the start
function. This code is output into the following functions, depending on the current value for the
CodeFormat TLC variable:

Function Name Value of CodeFormat TLC variable
model_initialize Embedded-C (if not ModelReferenceCoderTarget)
mdlStart Embedded-C (if ModelReferenceCoderTarget)
mdlStart S-Function
MdlStart RealTime

Each call to LibMdlStartCustomCode appends your buffer to the internal cache buffer.

See LibMdlStartCustomCode in hookslib.tlc.

LibMdlTerminateCustomCode(buffer, location)
Purpose

Places declaration statements and executable code inside the terminate function.

Syntax
LibMdlTerminateCustomCode(buffer, location)

Arguments

buffer — String buffer containing text to append to the internal cache buffer.
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location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibMdlTerminateCustomCode places declaration statements and executable code inside the
terminate function. This code is output into the following functions, depending on the current value of
the CodeFormat TLC variable:

Function Name Value of CodeFormat TLC variable
model_terminate Embedded-C
mdlTerminate S-Function
MdlTerminate RealTime

Each call to LibMdlTerminateCustomCode appends your buffer to the internal cache buffer.

See LibMdlTerminateCustomCode in hookslib.tlc.

LibSetRTModelErrorStatus(str)
Returns the code required to set the model error status.

Syntax
LibSetRTModelErrorStatus("\"Overrun\"")

Argument

str (string) — char * to a C string

See LibSetRTModelErrorStatus in codetemplatelib.tlc.

LibSetSourceFileCodeTemplate(opFile, name)
By default, *.c and *.h files are generated with the code templates specified in the Code
Generation > Templates pane of the Configuration Parameters dialog box.
LibSetSourceFileCodeTemplate allows you to change the template for a file.

Note Custom templates are a feature of the Embedded Coder product.

Syntax
%assign tag = LibSetSourceFileCodeTemplate(opFile,name)
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Arguments

opFile (scope) — Reference to file

name (string) — Name of the desired template

Returns

Nothing

See LibSetSourceFileCodeTemplate in codetemplatelib.tlc.

LibSetSourceFileCustomSection(file, attrib, value)
Adds to the contents of a custom section previously created with
LibAddSourceFileCustomSection. Available only with Embedded Coder software.

Arguments

file (scope or number) — Source file reference or index

attrib (string) — Name of custom section

value (string) — Value to be appended to section

See LibSetSourceFileCustomSection in codetemplatelib.tlc.

LibSetSourceFileOutputDirectory(opFile, name)
By default, *.c and *.h files are generated into a build folder at the current location.
LibSetSourceFileOutputDirectory allows you to change the folder into which a specified
source file is to be generated. Note that the caller is responsible for specifying a valid folder.

Syntax

%assign tag = LibSetSourceFileOutputDirectory(opFile,dirName)

Arguments

opFile (scope) — Reference to file

dirName (string) — Name of the desired output folder

Returns

Nothing

See LibSetSourceFileOutputDirectory in codetemplatelib.tlc.

LibSetSourceFileSection(fileH, section, value)
Adds to the contents of a specified section within a specified file. Valid file sections include
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File Section Description
Banner Set the file banner (comment) at the top of the file.
Includes Append to the #include section.
Defines Append to the #define section.
IntrinsicTypes Append to the intrinsic typedef section. Intrinsic types are those that

depend only on intrinsic C types.
PrimitiveTypedefs Append to the primitive typedef section. Primitive typedefs are

those that depend only on intrinsic C types and typedefs previously
defined in the IntrinsicTypes section.

UserTop Append to the User Top section.
Typedefs Append to the typedef section. The typedefs can depend on a

previously defined type.
Enums Append to the enumerated types section.
Definitions Append to the data definition section.
ExternData (Reserved) Code generator extern data.
ExternFcns (Reserved) Code generator extern functions.
FcnPrototypes (Reserved) Code generator function prototypes.
Declarations Append to the data declaration section.
Functions Append to the C functions section.
CompilerErrors Append to the #error section.
CompilerWarnings Append to the #warning section.
Documentation Append to the documentation (comment) section.
UserBottom Append to the User Bottom section.

The code generator orders the code as listed above.

Syntax

Example (iterating over the files):

%openfile tmpBuf
  whatever
%closefile tmpBuf
  
%foreach fileIdx = LibGetNumSourceFiles()
  %assign fileH = LibGetSourceFileFromIdx(fileIdx)
  %<LibSetSourceFileSection(fileH,"SectionOfInterest",tmpBuf)>
%endforeach
  
%assign fileH = LibCreateSourceFile("Header","Custom","foofile")
%<LibSetSourceFileSection(fileH,"Defines","#define FOO 5.0\n")>

Arguments

fileH (scope or number) — Reference or index to a file

section (string) — File section of interest
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value (string) — Value

See LibSetSourceFileSection in codetemplatelib.tlc.

LibSystemDerivativeCustomCode(system, buffer, location)
Purpose

Places declaration statements and executable code inside a subsystem's derivative function.

Syntax
LibSystemDerivativeCustomCode(system, buffer, location)

Arguments

system — Reference to the subsystem whose derivative function is to be modified.

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibSystemDerivativeCustomCode places declaration statements and executable code inside the
derivative function for the subsystem specified by system. This code is output into the following
functions, depending on the current value of the CodeFormat TLC variable:

Function Name Value of CodeFormat TLC variable
mdlDerivatives S-Function
model_derivatives RealTime

LibSystemDerivativeCustomCode is not relevant when the value of the CodeFormat TLC
variable is Embedded-C, because blocks with continuous states cannot be used.

Each call to LibSystemDerivativeCustomCode appends your buffer to the internal cache buffer.
An error is generated if you attempt to add code to a subsystem that does not have continuous states.

See LibSystemDerivativeCustomCode in hookslib.tlc.

Note To avoid a potential mismatch between simulation and code generation results, do not use
LibSystemDerivativeCustomCode to read from and write to global Simulink data (signals, states,
and block parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data
Store Write, State Reader, and State Writer blocks.)
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LibSystemDisableCustomCode(system, buffer, location)
Purpose

Places declaration statements and executable code inside a subsystem's disable function.

Syntax

LibSystemDisableCustomCode(system, buffer, location)

Arguments

system — Reference to the subsystem whose disable function is to be modified.

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibSystemDisableCustomCode places declaration statements and executable code inside the
disable function for the subsystem specified by system. Each call to
LibSystemDisableCustomCode appends your buffer to the internal cache buffer.

An error is generated if you attempt to add code to a subsystem that does not have a disable function.

See LibSystemDisableCustomCode in hookslib.tlc.

Note To avoid a potential mismatch between simulation and code generation results, do not use
LibSystemDisableCustomCode to read from and write to global Simulink data (signals, states, and
block parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data
Store Write, State Reader, and State Writer blocks.)

LibSystemEnableCustomCode(system, buffer, location)
Purpose

Places declaration statements and executable code inside a subsystem's enable function.

Syntax

LibSystemEnableCustomCode(system, buffer, location)

 Code Configuration Functions

22-47



Arguments

system — Reference to the subsystem whose enable function is to be modified.

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibSystemEnableCustomCode places declaration statements and executable code inside the enable
function for the subsystem specified by system. Each call to LibSystemEnableCustomCode
appends your buffer to the internal cache buffer.

An error is generated if you attempt to add code to a subsystem that does not have an enable
function.

See LibSystemEnableCustomCode in hookslib.tlc.

Note To avoid a potential mismatch between simulation and code generation results, do not use
LibSystemEnableCustomCode to read from and write to global Simulink data (signals, states, and
block parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data
Store Write, State Reader, and State Writer blocks.)

LibSystemInitializeCustomCode(system, buffer, location)
Purpose

Places declaration statements and executable code inside a subsystem's initialize function.

Syntax

LibSystemInitializeCustomCode(system, buffer, location)

Arguments

system — Reference to the subsystem whose initialize function is to be modified.

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
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• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibSystemInitializeCustomCode places declaration statements and executable code inside the
initialize function for the subsystem specified by system. This code is output into the following
functions, depending on the current value of the CodeFormat TLC variable:

Function Name Value of CodeFormat TLC variable
model_initialize Embedded-C
mdlInitializeConditions S-Function
MdlStart RealTime

Code for a subsystem is output into the subsystem's initialization function. Each call to
LibSystemInitializeCustomCode appends your buffer to the internal cache buffer.

Note Enable systems that are not configured to reset on enable are inlined into MdlStart. For this
case, the subsystem's custom code is found in MdlStart above and below the enable subsystem's
initialization code.

See LibSystemInitializeCustomCode in hookslib.tlc.

Note To avoid a potential mismatch between simulation and code generation results, do not use
LibSystemInitializeCustomCode to read from and write to global Simulink data (signals, states,
and block parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data
Store Write, State Reader, and State Writer blocks.)

LibSystemOutputCustomCode(system, buffer, location)
Purpose

Places declaration statements and executable code inside a subsystem's output function.

Syntax
LibSystemOutputCustomCode(system, buffer, location)

Arguments

system — Reference to the subsystem whose output function is to be modified.

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are
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• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibSystemOutputCustomCode places declaration statements and executable code inside the output
function for the subsystem specified by system. This code is output into the following functions,
depending on the current value of the CodeFormat TLC variable:

Function Name Value of CodeFormat TLC variable
model_step Embedded-C (CombineOutputUpdateFcns is 1)
model_output Embedded-C (CombineOutputUpdateFcns is 0)
mdlOutputs S-Function
MdlOutputs RealTime

Each call to LibSystemOutputCustomCode appends your buffer to the internal cache buffer.

See LibSystemOutputCustomCode in hookslib.tlc.

Note To avoid a potential mismatch between simulation and code generation results, do not use
LibSystemOutputCustomCode to read from and write to global Simulink data (signals, states, and
block parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data
Store Write, State Reader, and State Writer blocks.)

LibSystemUpdateCustomCode(system, buffer, location)
Purpose

Places code inside a subsystem's update function.

Syntax

LibSystemUpdateCustomCode(system, buffer, location)

Arguments

system — Reference to the subsystem whose update function is to be modified.

buffer — String buffer containing text to append to the internal cache buffer.

location — String specifying where to place the buffer's contents. Possible values are

• "header" — Place buffer at top of function
• "declaration" — Place buffer at top of function
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• "execution" — Place buffer at top of function, but after header
• "trailer" — Place buffer at bottom of function

Returns

Nothing

Description

LibSystemUpdateCustomCode places declaration statements and executable code inside the
update function for the subsystem specified by system. This code is output into the following
functions, depending on the current value of the CodeFormat TLC variable:

Function Name Value of CodeFormat TLC variable
model_step Embedded-C (CombineOutputUpdateFcns is 1)
model_update Embedded-C (CombineOutputUpdateFcns is 0)
mdlUpdate S-Function
MdlUpdate RealTime

Each call to LibSystemUpdateCustomCode appends your buffer to the internal cache buffer.

See LibSystemUpdateCustomCode in hookslib.tlc.

Note To avoid a potential mismatch between simulation and code generation results, do not use
LibSystemUpdateCustomCode to read from and write to global Simulink data (signals, states, and
block parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data
Store Write, State Reader, and State Writer blocks.)

LibWriteModelData()
Returns data for the model (valid for ERT only).

See LibWriteModelData in codetemplatelib.tlc.

LibWriteModelInput(tid, rollThreshold)
Returns the code for writing to a specified root input (that is, a model inport block). This function is
valid for ERT only, and not valid for referenced models.

Arguments

tid (number) — Task identifier (0 is fastest rate and n is the slowest)

rollThreshold — Width of signal before wrapping in a for loop.

See LibWriteModelInput in codetemplatelib.tlc.
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LibWriteModelInputs()
Returns code that writes to all root inputs (that is, the model inport blocks). This function is valid for
ERT only, and is not valid for referenced models.

See LibWriteModelInputs in codetemplatelib.tlc.

LibWriteModelOutput(tid, rollThreshold)
Returns code that writes to a specified root output (that is, a model outport block). This function is
valid for ERT only, and not valid for referenced models.

Arguments

tid (number) — Task identifier (0 is fastest rate and n is the slowest)

rollThreshold — Width of signal before wrapping in a for loop.

See LibWriteModelOutput in codetemplatelib.tlc.

LibWriteModelOutputs()
Returns code that writes to all root outputs (that is, the model outport blocks). This function is valid
for ERT only, and not valid for referenced models.

See LibWriteModelOutputs in codetemplatelib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Sample Time Functions

LibAsynchronousTriggeredTID(tid)
Returns whether this TID corresponds to a asynchronous triggered rate.

See LibAsynchronousTriggeredTID in utillib.tlc.

LibAsyncTaskAccessTimeInFcn(tid, fcnType)
Returns 1 if the specified asynchronous task identifier (TID) is given function type.

See LibAsyncTaskAccessTimeInFcn in utillib.tlc.

LibBlockSampleTime(block)
Returns the block's sample time. The returned value depends on the sample time classification of the
block, as shown in the following table.

Block Classification Returned Value
Discrete The actual sample time of a block (real > 0)
Continuous 0.0
Triggered -1.0
Constant -2.0

See LibBlockSampleTime in blocklib.tlc.

LibGetClockTick(tid)
Returns integer task time (current clock tick of the task timer). The resolution of the timer can be
obtained from LibGetClockTickStepSize(tid). The data type ID of the timer can be obtained
from LibGetClockTickDataTypeId(tid).

See LibGetClockTick in utillib.tlc.

LibGetClockTickDataTypeId(tid)
Returns clock tick data type ID.

See LibGetClockTickDataTypeId in utillib.tlc.

LibGetClockTickHigh(tid)
Returns high-order word of the integer task time. LibGetClockTickHigh is used when uint32
pairs are used to store absolute time. The resolution of a clock tick can be obtained from
LibGetClockTickStepSize(tid).

See LibGetClockTickHigh in utillib.tlc.
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LibGetClockTickStepSize(tid)
Returns clock tick step size, which is the resolution of the integer task time.
LibGetClockTickStepSize cannot be used if the task does not have a timer.

See LibGetClockTickStepSize in utillib.tlc.

LibGetElapseTime(system)
Returns time elapsed since the last time the subsystem started to execute.

See LibGetElapseTime in utillib.tlc.

LibGetElapseTimeCounter(system)
Returns an integer elapsed time. This is the number of clock ticks elapsed since the last time the
system started. To get real-world elapsed time, this integer elapsed time must be multiplied by the
applicable resolution.

You can obtain the resolution by calling LibGetElapseTimeResolution(system). You can obtain
the data type ID of the integer elapsed time counter by calling
LibGetElapseTimeCounterDTypeId(system).

See LibGetElapseTimeCounter in utillib.tlc.

LibGetElapseTimeCounterDTypeId(system)
Returns the date type ID of the integer elapsed time returned by LibGetElapseTimeCounter.

See LibGetElapseTimeCounterDTypeId in utillib.tlc.

LibGetElapseTimeResolution(system)
Returns the resolution of the elapsed time returned by LibGetElapseTimeCounter.

See LibGetElapseTimeResolution in utillib.tlc.

LibGetGlobalTIDFromLocalSFcnTID(sfcnTID)
Returns the model task identifier (sample time index) corresponding to the specified local S-function
task identifier or port sample time. LibGetGlobalTIDFromLocalSFcnTID allows you to use one
function to determine a global TID, independent of port- or block-based sample times.

The input argument to LibGetGlobalTIDFromLocalSFcnTID should be one of the following:

• For block-based sample times (e.g., in S-function mdlInitializeSizes,
ssSetNumSampleTimes(S, N) with N > 1 was specified), sfcnTID is a nonnegative integer
giving the corresponding local S-function sample time.

• For port-based sample times (e.g., in S-function mdlInitializeSizes,
ssSetNumSampleTimes(S, PORT_BASED_SAMPLE_TIMES) was specified), sfcnTID is a string
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of the form "InputPortIdxI" or "OutputPortIdxI", where I is an integer ranging from 0 to
the number of ports (e.g., "InputPortIdx0".

Examples

Multirate block

%assign globalTID = LibGetGlobalTIDFromLocalSFcnTID(2)

or

%assign globalTID = 
LibGetGlobalTIDFromLocalSFcnTID("InputPortIdx4") 
%assign period = 
CompiledModel.SampleTime[globalTID].PeriodAndOffset[0]
%assign offset = 
CompiledModel.SampleTime[globalTID].PeriodAndOffset[1]

Inherited sample time block

%switch (LibGetSFcnTIDType(0)) 
  %case "discrete" 
  %case "continuous" 
    %assign globalTID = LibGetGlobalTIDFromLocalSFcnTID(2) 
    %assign period = ... 
      CompiledModel.SampleTime[globalTID].PeriodAndOffset[0] 
    %assign offset = ... 
      CompiledModel.SampleTime[globalTID].PeriodAndOffset[1] 
    %break 
  %case "triggered" 
    %assign period = -1 
    %assign offset = -1 
    %break 
  %case "constant" 
    %assign period = rtInf 
    %assign offset = 0 
    %break 
  %default 
    %<LibBlockReportFatalError([],"Unknown tid type")> 
%endswitch

See LibGetGlobalTIDFromLocalSFcnTID in utillib.tlc.

LibGetNumAsyncTasks()
Return the number of asynchronous tasks in generated code.

See LibGetNumAsyncTasks in utillib.tlc.

LibGetNumSFcnSampleTimes(block)
Returns the number of S-function sample times for a block.

See LibGetNumSFcnSampleTimes in utillib.tlc.
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LibGetNumSyncPeriodicTasks()
Return the number of periodic tasks in generated code.

See LibGetNumSyncPeriodicTasks in utillib.tlc.

LibGetNumTasks()
Return the number of tasks in generated code.

See LibGetNumTasks in utillib.tlc.

LibGetSampleTimePeriodAndOffset(tid, idx)
Returns the sample time period value or offset value for a specified task.

Arguments

tid — Specify the identifier of the task for which to return information.

idx — Specify 0 to return the sample time period value or 1 to return the sample time offset value.

Examples

%% Get sample time period and offset for task 0
%assign sampleTime = LibGetSampleTimePeriodAndOffset(0,0)
%assign offsetTime = LibGetSampleTimePeriodAndOffset(0,1)

%% Get sample time periods for tasks 0 and 1
%assign periodTID0 = LibGetSampleTimePeriodAndOffset(0,0)
%assign periodTID1 = LibGetSampleTimePeriodAndOffset(1,0)

See LibGetSampleTimePeriodAndOffset in codetemplatelib.tlc.

LibGetSFcnTIDType(sfcnTID)
Returns the type of the specified S-function task identifier (sfcnTID). Possible values are:

• "continuous" — The specified sfcnTID is continuous.
• "discrete" — The specified sfcnTID is discrete.
• "triggered" — The specified sfcnTID is triggered.
• "constant" — The specified sfcnTID is constant.

The format of sfcnTID must be the same as for LibIsSFcnSampleHit.

Note This is useful primarily in the context of S-functions that specify an inherited sample time.

See LibGetSFcnTIDType in utillib.tlc.
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LibGetTaskTime(tid)
Returns a string to access the absolute time of the task, which is a floating-point number. However, if
you have configured the model for integer-only code generation (by deselecting Support floating-
point numbers), the string represents an integer equal to the number of base rate ticks (the
absolute time divided by the base sample time) rather than the absolute time. In integer-only code,
the task time is an integer time value whose resolution is the model fundamental step size.

LibGetTaskTime is the TLC version of the SimStruct macro: "ssGetTaskTime(S,tid)".

See LibGetTaskTime in utillib.tlc.

LibGetTaskTimeFromTID(block)
Returns a string to access the absolute time of the task associated with the block.

If the value of the CodeFormat TLC variable is not Embedded-C, LibGetTaskTimeFromTID returns
the string "RTMGet("T")" if the block is constant or the system is single rate, and
"RTMGetTaskTimeForTID(tid)" otherwise.

If the value for the CodeFormat TLC variable is Embedded-C, LibGetTaskTimeFromTID returns
"RTMGetTaskTimeForTID(tid)".

If the block is constant or the system is single rate, this is the TLC version of the SimStruct macro:
"ssGetT(S)" and "ssGetTaskTime(S, tid)" otherwise.

In both cases, S is the name of the SimStruct.

See LibGetTaskTimeFromTID in utillib.tlc.

LibGetTID01EQ()
Returns the value of the TID01EQ flag — true (1) if sampling rates of the continuous task and the first
discrete task are equal and false (0) otherwise.

When a model has continuous time and the flag TID01EQ is true, both continuous time and the fastest
discrete time are treated as one rate in generated code. The code associated with the fastest discrete
rate is guarded by a major time step check. When the model has only two rates, and TID01EQ is true,
the generated code has a single-rate call interface.

Use LibGetTID01EQ to detect and account for the case where continuous time and the fastest
discrete time are treated as one rate.

See LibGetTID01EQ in codetemplatelib.tlc, bareboard_mrmain.tlc, and ertmainlib.tlc.

LibIsContinuous(TID)
Returns 1 if the specified task identifier (TID) is continuous and 0 otherwise. Note that task
identifiers equal to "triggered" or "constant" are not continuous.

See LibIsContinuous in utillib.tlc.
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LibIsDiscrete(TID)
Returns 1 if the specified task identifier (TID) is discrete and 0 otherwise. Note that task identifiers
equal to "triggered" or "constant" are not discrete.

See LibIsDiscrete in utillib.tlc.

LibIsSFcnSampleHit(sfcnTID)
Returns 1 if a sample hit occurs for the specified local S-function task identifier (TID) and 0
otherwise.

The input argument to LibIsSFcnSampleHit should be one of the following:

• sfcnTID: integer (e.g., 2)

For block-based sample times (e.g., in S-function mdlInitializeSizes,
ssSetNumSampleTimes(S,N) with N > 1 was specified), sfcnTID is an integer starting at 0 of
the corresponding local S-function sample time.

• sfcnTID: "InputPortIdxI" or "OutputPortIdxI" (e.g., "InputPortIdx0").

For port-based sample times (e.g., in S-function mdlInitializeSizes,
ssSetNumSampleTimes(S,PORT_BASED_SAMPLE_TIMES) was specified), sfcnTID is a string
giving the input (or output) port index.

Examples

• Consider a multirate S-function block with four block sample times. The call
LibIsSFcnSampleHit(2) returns the code to check for a sample hit on the third S-function
block sample time.

• Consider a multirate S-function block with three input and eight output sample times. The call
LibIsSFcnSampleHit("InputPortIdx0") returns the code to check for a sample hit on the
first input port. The call LibIsSFcnSampleHit("OutputPortIdx7") returns the code to check
for a sample hit on the eighth output port.

See LibIsSFcnSampleHit in utillib.tlc.

LibIsSFcnSingleRate(block)
Returns a Boolean value (1 or 0) indicating whether the S-function is single rate (one sample time) or
multirate (multiple sample times).

See LibIsSFcnSingleRate in utillib.tlc.

LibIsSFcnSpecialSampleHit(sfcnSTI, sfcnTID)
Returns the Simulink macro to promote a slow task (sfcnSTI) into a faster task (sfcnTID).

This advanced function is specifically intended for use in rate transition blocks.
LibIsSFcnSpecialSampleHit determines the global TID from the S-function TID

The input arguments to LibIsSFcnSpecialSampleHit are
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• For multirate S-function blocks:

sfcnSTI: local S-function sample time index (sti) of the slow task that is to be promoted

sfcnTID: local S-function task ID (tid) of the fast task where the slow task is to run
• For single-rate S-function blocks using SS_OPTION_RATE_TRANSITION, sfcnSTI and sfcnTID

are ignored and should be specified as "".

The format of sfcnSTI and sfcnTID must follow that of the argument to LibIsSFcnSampleHit.

Examples

• A rate transition S-function (one sample time with SS_OPTION_RATE_TRANSITION)

if (%<LibIsSFcnSpecialSampleHit("","")>) {
• A multirate S-function with port-based sample times where the output rate is slower than the

input rate (e.g., a zero-order hold operation)
if (%<LibIsSFcnSpecialSampleHit("OutputPortIdx0","InputPortIdx0")>) {

See LibIsSFcnSpecialSampleHit in utillib.tlc.

LibIsSingleRateModel()
Returns true if model is single rate and false otherwise.

See LibIsSingleRateModel in codetemplatelib.tlc.

LibIsSingleTasking()
Returns true if the model is configured for single-tasking execution and false if the model is
configured for multitasking execution.

See LibIsSingleTasking in codetemplatelib.tlc.

LibIsZOHContinuous(TID)
Returns 1 if the specified task identifier (TID) is zero order hold (ZOH) continuous and 0 otherwise. A
TID equal to triggered or constant is not ZOH continuous.

See LibIsZOHContinuous in utillib.tlc.

LibNumAsynchronousSampleTimes()
Returns the number of asynchronous sample times in the model.

See LibNumAsynchronousSampleTimes in codetemplatelib.tlc.

LibNumDiscreteSampleTimes()
Returns the number of discrete sample times in the model.

See LibNumDiscreteSampleTimes in codetemplatelib.tlc.
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LibNumSynchronousSampleTimes()
Returns the number of synchronous sample times in the model.

See LibNumSynchronousSampleTimes in codetemplatelib.tlc.

LibPortBasedSampleTimeBlockIsTriggered(block)
Determines whether the port-based S-function block is triggered.

See LibPortBasedSampleTimeBlockIsTriggered in blocklib.tlc.

LibSetVarNextHitTime(block, tNext)
Generates code to set the next variable hit time. Blocks with variable sample time must call
LibSetVarNextHitTime in their output functions.

See LibSetVarNextHitTime in blocklib.tlc.

LibTriggeredTID(tid)
Returns whether this TID corresponds to a triggered rate.

See LibTriggeredTID in utillib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Miscellaneous Functions

LibAddtoSystemCustomIncludes(system, incFileName)
For use by inlined S-functions within a subsystem. Adds #include file to the system header file.

Call this function from the “BlockInstanceSetup(block, system)” on page 21-21 method of the block so
that different S-functions can include different header files. Specify your header file without any
braces (for example, "myInclude.h") and include the system header file in braces (for example,
"<sysinclude.h>").

Each call to this function adds the file to the list of included headers files only if it is not already
included.

Example

%function BlockInstanceSetup(block, system) Output
  %assign incFileName = "sfun_custincl.h"
  %<LibAddToSystemCustomIncludes(system, incFileName)>
%endfunction

%function Outputs(block, system) Output
%endfunction

See LibAddToSystemCustomIncludes in commonhdrlib.tlc.

LibBlockExecuteFcnCall(block, callIdx)
For use by inlined S-functions with function-call outputs. Returns a string to call the function-call
subsystem with required arguments or generates the subsystem's code in place (inlined).

Example

%foreach callIdx = NumSFcnSysOutputCalls
  %if LibIsEqual(SFcnSystemOutputCall[callIdx].BlockToCall,...
   "unconnected")
    %continue
  %endif
%% call the downstream system
  %<LibBlockExecuteFcnCall(block, callIdx)>\
%endforeach

See LibBlockExecuteFcnCall in syslib.tlc.

LibBlockExecuteFcnDisable(block, callIdx)
For use by inlined S-Functions to call the function-call system disable function. Returns a string to
either call the function-call subsystem disable function with required arguments or to call the
generated subsystem disable code (inlined).

Example
%foreach callIdx = NumSFcnSysOutputCallDsts
  %if LibIsEqual(SFcnSystemOutputCall[callIdx].BlockToCall, "unconnected")
   %continue
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  %endif
%% call the downstream system
  %<LibBlockExecuteFcnDisable(block, callIdx)>\
%endforeach

See LibBlockExecuteFcnDisable in syslib.tlc.

LibBlockExecuteFcnEnable(block, callIdx)
For use by inlined S-Functions to call the function-call system enable function. Returns a string to call
the function-call subsystem enable function with required arguments or the generated subsystem
enable code (inlined).

Example
%foreach callIdx = NumSFcnSysOutputCallDsts
  %if LibIsEqual(SFcnSystemOutputCall[callIdx].BlockToCall, "unconnected")
   %continue
  %endif
%% call the downstream system
  %<LibBlockExecuteFcnEnable(block, callIdx)>\
%endforeach

See LibBlockExecuteFcnEnable in syslib.tlc.

LibBlockInputSignalAliasedThruDataTypeId(idx)
Return the data type ID the input signal is aliased thru to.

See LibBlockInputSignalAliasedThruDataTypeId in dtypelib.tlc.

LibBlockOutputSignalAliasedThruDataTypeId(idx)
Return the data type ID the output signal is aliased thru to.

See LibBlockOutputSignalAliasedThruDataTypeId in dtypelib.tlc

LibGenConstVectWithInit(data, typeId, varId)
Returns an initialized static constant variable string of form:

static const typeName varId[] = { data };

The typeName is generated from typeId, which can be one of

tSS_DOUBLE, tSS_SINGLE, tSS_BOOLEAN, tSS_INT8, tSS_UINT8, 
tSS_INT16, tSS_UINT16, tSS_INT32, tSS_UINT32

The data input argument must be a numeric scalar or vector and must be finite (no Inf, -Inf, or
NaN values).

See LibGenConstVectWithInit in utillib.tlc.

LibGetBlockAttribute(block, attr)
Get a field value inside a block record.
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Syntax

%if LibIsEqual(LibGetBlockAttribute(ssBlock,"MaskType"), ... 
  "Task Block")
  %assign isTaskBlock = 1
%endif

Returns

Returns the value of the attribute (field) or an empty string if it does not exist.

See LibGetBlockAttribute in asynclib.tlc.

LibGetCallerClockTickCounter(sfcnBlock)
For use by asynchronous S-functions with function call outputs. Asynchronous tasks can manage their
own time. LibGetCallerClockTickCounter is used to access an upstream asynchronous task's
time counter. This is preferred when being driven by another asynchronous rate (e.g., an Interrupt
block driving a Task block) because the time the interrupt occurred is used, rather than the time the
task is allowed to run.

Returns

Returns a string for the counter variable for the upstream asynchronous task.

See LibGetCallerClockTickCounter in asynclib.tlc.

LibGetCallerClockTickCounterHigh(sfcnBlock)
For use by asynchronous S-functions with function-call outputs. Asynchronous tasks can manage their
own time. LibGetCallerClockTickCounterHigh is used to access the high word of an upstream
asynchronous task's time counter. This is preferred when being driven by another asynchronous rate
(for example, an Interrupt block driving a Task block) because the time the interrupt occurred is used
rather than the time the Task is allowed to run.

Returns

Returns a string for the high word of the counter variable for the upstream asynchronous task.

See LibGetCallerClockTickCounterHigh in asynclib.tlc.

LibGetDataTypeComplexNameFromId(id)
Returns the name of the complex data type corresponding to a data type ID. For example, if
id==tSS_DOUBLE then LibGetDataTypeComplexNameFromId returns "creal_T".

See LibGetDataTypeComplexNameFromId in dtypelib.tlc.

LibGetDataTypeEnumFromId(id)
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Returns the data type enum corresponding to a data type ID. For example, if id==tSS_DOUBLE, then
enum is "SS_DOUBLE". If id does not correspond to a built-in data type,
LibGetDataTypeEnumFromId returns "".

See LibGetDataTypeEnumFromId in dtypelib.tlc.

LibGetDataTypeIdAliasedThruToFromId(id)
Returns the data type IdAliasedThruTo that corresponds to a data type ID. For example, if
yourfloat is an alias to myfloat, and myfloat is an alias to double, then the IdAliasedThruTo
for both yourfloat and myfloat is 0 (because the ID for double is 0).

See LibGetDataTypeIdAliasedThruToFromId in dtypelib.tlc.

LibGetDataTypeIdAliasedToFromId(id)

Returns the data type IdAliasedTo that corresponds to a data type ID. For example, if yourfloat
is an alias to myfloat, and myfloat is an alias to double, then the IdAliasedTo for yourfloat is
the ID for myfloat, and the IdAliasedTo for myfloat is 0 (because the ID for double is 0).

See LibGetDataTypeIdAliasedToFromId in dtypelib.tlc.

LibGetDataTypeIdResolvesToFromId(id)

Returns the data type IdResolvesTo that corresponds to a data type ID.

See LibGetDataTypeIdResolvesToFromId in dtypelib.tlc.

LibGetDataTypeNameFromId(id)

Returns the data type name that corresponds to a data type ID.

See LibGetDataTypeNameFromId in dtypelib.tlc.

LibGetDataTypeSLSizeFromId(id)
Return the size (as Simulink knows it) corresponding to a data type ID.

See LibGetDataTypeSLSizeFromId in dtypelib.tlc.

LibGetDataTypeStorageIdFromId(id)
Returns the data type StorageId corresponding to a data type ID. For example, if the input ID is the
ID for a 16-bit signed fixed-point data type, then the StorageId corresponds to int16.

See LibGetDataTypeStorageIdFromId in dtypelib.tlc.
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LibGetFcnCallBlock(sfcnblock,callIdx)
Given an S-function block and call index, return the block record for the downstream function-call
subsystem block.

Syntax

 %assign ssBlock = LibGetFcnCallBlock(block,0)

Returns

The block record of the downstream function-call subsystem connected to that element (call index).

See LibGetFcnCallBlock in asynclib.tlc.

LibGetRecordDataTypeId(rec)
Returns the data type identifier of the specified record as an integer.

See LibGetRecordDataTypeId in dtypelib.tlc.

LibGetRecordDimensions(rec)
Returns the dimensions of the specified record as a vector of integers.

See LibGetRecordDimensions in dtypelib.tlc.

LibGetRecordIsComplex(rec)
Returns the value 1 if the specified record is complex, and zero otherwise.

See LibGetRecordIsComplex in dtypelib.tlc.

LibGetRecordWidth(rec)
Returns the width of the specified record as an integer.

See LibGetRecordWidth in dtypelib.tlc.

LibGetT()
Returns a string to access the absolute time, which is a floating-point number. However, if you have
configured the model for integer-only code generation (by deselecting Support floating-point
numbers), the string represents an integer equal to the number of base rate ticks (the absolute time
divided by the base sample time) rather than the absolute time.

You should use LibGetT to access time only.

LibGetT is the TLC version of the SimStruct macro ssGetT.

See LibGetT in utillib.tlc.
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LibIsComplex(arg)

Returns 1 if the argument passed in is complex, 0 otherwise.

See LibIsComplex in utillib.tlc.

LibIsFirstInitCond()
LibIsFirstInitCond returns generated code intended for placement in the initialization function.
This code determines, during run-time, whether the initialization function is being called for the first
time.

LibIsFirstInitCond also sets a flag that tells the code generator if it needs to declare and
maintain the first-initialize-condition flag.

LibIsFirstInitCond is the TLC version of the SimStruct macro ssIsFirstInitCond.

See LibIsFirstInitCond in syslib.tlc.

LibIsMajorTimeStep()
Returns a string to access whether the current simulation step is a major time step.

LibIsMajorTimeStep is the TLC version of the SimStruct macro ssIsMajorTimeStep.

See LibIsMajorTimeStep in utillib.tlc.

LibIsMinorTimeStep()
Returns a string to access whether the current simulation step is a minor time step.

LibIsMinorTimeStep is the TLC version of the SimStruct macro ssIsMinorTimeStep.

See LibIsMinorTimeStep in utillib.tlc.

LibManageAsyncCounter(sfcnBlock, callIdx)
For use by asynchronous S-Functions with function-call outputs. Asynchronous tasks can manage
their own time, and use LibManageAsyncCounter to determine whether a need exists for an
asynchronous counter to manage its own timer.

Example

%if LibManageAsyncCounter(block,callIdx)
  %%      %<LibSetAsyncCounter(block,callIdx), CodeGetCounter)>

where CodeGetCounter is target specific code reading hardware timer.

Returns

Returns TLC_TRUE if an asynchronous counter is required to manage its own counter, otherwise
TLC_FALSE.
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See LibManageAsyncCounter in asynclib.tlc.

LibMaxIntValue(dtype)
For a built-in integer data type, LibMaxIntValue returns the formatted maximum value of that data
type.

See LibMaxIntValue in dtypelib.tlc.

LibMinIntValue(dtype)
For a built-in integer data type, LibMinIntValue returns the formatted minimum value of that data
type.

See LibMinIntValue in dtypelib.tlc.

LibNeedAsyncCounter(sfcnBlock, callIdx)
For use by asynchronous S-functions with function-call outputs. Asynchronous tasks use
LibNeedAsyncCounter to determine whether a need exists for an asynchronous counter.

Example

%if LibNeedAsyncCounter(block,0)
  %<LibSetAsyncCounter(block,0), "tickGet()")>

Returns

Returns TLC_TRUE if an asynchronous counter is required, otherwise TLC_FALSE.

See LibNeedAsyncCounter in asynclib.tlc.

LibSetAsyncClockTicks(sfcnBlock, callIdx, buf1, buf2)
For use by asynchronous S-functions with function-call outputs. Asynchronous tasks can manage their
own time. Use LibSetAsyncClockTicks to return code that sets clockTick counters that are to
be maintained by the asynchronous task. If the data type of a clockTick counter maintained by the
asynchronous task is tSS_TIMER_UINT32_PAIR, the low and high word of the clockTick counter
are set.

Arguments

buf1 — Code that reads the low word of the hardware counter

buf2 — Code that reads the high word of the hardware counter. Leave buf2 empty if hardware
counter length is less than 32 bits.

Returns

Returns code that sets clockTick counters that are to be maintained by the asynchronous task.
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Example

%if LibNeedAsyncCounter(block, callIdx)
%<LibSetAsyncCounter(block, 0, buf1, buf2)>
%endif

See LibSetAsyncClockTicks in asynclib.tlc.

LibSetAsyncCounter(sfcnBlock, callIdx, buf)
For use by asynchronous S-functions with function-call outputs. Asynchronous tasks can manage their
own time. Use LibSetAsyncCounter to return code that sets a counter variable that is to be
maintained by the asynchronous task.

Returns

Returns code that sets the counter variable that is to be maintained by the asynchronous task.

Example

%if LibNeedAsyncCounter(block,0)
  %<LibSetAsyncCounter(block,0, "tickGet()")> 
%endif

See LibSetAsyncCounter in asynclib.tlc.

LibSetAsyncCounterHigh(sfcnBlock, callIdx, buf)
For use by asynchronous S-functions with function-call outputs. Asynchronous tasks can manage their
own time. Use LibSetAsyncCounterHigh to return code that sets the higher word of the counter
variable that is to be maintained by the asynchronous task.

Returns

Returns code that sets the higher word of the counter variable that is to be maintained by the
asynchronous task.

Example

%if LibNeedAsyncCounter(block,0)
%<LibSetAsyncCounterHigh(block,0, "hightTickGet()")>
%endif

See LibSetAsyncCounterHigh in asynclib.tlc.

LibTIDInSystem(system, fcnType)
Purpose

Returns a task identifier (TID) if it is in the scope of a subsystem function and can be called before or
during TLC generating code.

Syntax

LibTIDInSystem(system, fcnType)
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Arguments

system
A record within the global CompiledModel record.

fcnType
One of the following: 'Output', 'Update', 'Outputupdate'.

Description

This function returns a TID if it is in the scope of a subsystem function and can be called before or
during TLC generating code. It returns the TID argument name, if a TID is passed as argument in the
system function scope. If TID is not passed as argument in the scope, this function returns:

• '0' if model is single tasking.
• The TID value of the subsystem if the subsystem is single rate.
• A local TID variable name, if the subsystem is multirate. A local TID variable is added to the

subsystem code.

Note This function issue an error message if it is called for a reusable subsystem whose instances
run at different rates.

See LibTIDInSystem in syslib.tlc.

LibIsRowMajor
Returns true when the current model uses the row-major array layout.

See LibIsRowMajor in dtypelib.tlc.

Obsolete Functions
The following table shows obsolete functions and the functions that have replaced them.

Obsolete Function Equivalent Replacement Function
LibBlockOutportLocation LibBlockDstSignalLocation
LibCacheGlobalPrmData Use the block function Start
LibCacheIncludes LibAddToCommonIncludes
LibContinuousState LibBlockContinuousState
LibControlPortInputSignal LibBlockSrcSignalLocation
LibConvertZCDirection Function is not used in code generation.
LibDataInputPortWidth LibBlockInputSignalWidth
LibDataOutputPortWidth LibBlockOutputSignalWidth
LibDefineIWork
LibDefinePWork
LibDefineRWork

IWork , PWork, and RWork names are now specified
via the mdlRTW function in your C MEX S-function.
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Obsolete Function Equivalent Replacement Function
LibDiscreteState LibBlockDiscreteState
LibExportFileCustomCode LibSetSourceFileSection
LibExternalResetSignal LibBlockInputSignal
LibHeaderFileCustomCode LibSetSourceFileSection
LibIsEqual Use built-in function ISEQUAL
LibMapSignalSource FcnMapDataTypedSignalSource
LibMaxBlockIOWidth Function is not used in Simulink Coder code

generation.
LibMaxDataInputPortWidth Function is not used in Simulink Coder code

generation.
LibMaxDataOutputPortWidth Function is not used in Simulink Coder code

generation.
LibPathName LibGetBlockPath, LibGetFormattedBlockPath
LibPrevZCState LibBlockPrevZCState
LibPrmFileCustomCode LibSetSourceFileSection
LibRegFileCustomCode LibSetSourceFileSection
LibRegisterGNUMathFcnPrototypes Function is not used in Simulink Coder code

generation.
LibRegisterISOCMathFcnPrototypes Function is not used in Simulink Coder code

generation.
LibRegisterMathFcnPrototype Function is not used in Simulink Coder code

generation.
LibRenameParameter Specifying parameter names is now supported via the

mdlRTW function in your C MEX S-function.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Advanced Functions

LibAppendToModelReferenceUserData(data)
Appends the given data object to the user data in the binfo file for the model currently being built.
This function is only called during builds for model reference targets.

Note The data argument cannot be a vector or matrix. To work around this limitation, create a
record with a field containing the vector or matrix data and pass this record into the function.

See LibAppendToModelReferenceUserData in modelrefutil.tlc.

LibBlockInputSignalBufferDstPort(portIdx)
Returns the output port corresponding to input port (portIdx) that share the same memory,
otherwise (-1) is returned. You will need to use LibBlockInputSignalBufferDstPort when you
specify ssSetInputPortOverWritable(S,portIdx,TRUE) in your S-function.

If an input port and some output port of a block are

• Not test points, and
• The input port is overwritable

then the output port might reuse the same buffer as the input port. In this case,
LibBlockInputSignalBufferDstPort returns the index of the output port that reuses the
specified input port's buffer. If none of the block's output ports reuse the specified input port buffer,
then LibBlockInputSignalBufferDstPort returns -1.

LibBlockInputSignalBufferDstPort is the TLC version of the Simulink macro
ssGetInputPortBufferDstPort.

Example

Assume you have a block that has two input ports, both of which receive a complex number in 2-wide
vectors. The block outputs the product of the two complex numbers.

%assign u1r = LibBlockInputSignal (0, "", "", 0)
%assign u1i = LibBlockInputSignal (0, "", "", 1)
%assign u2r = LibBlockInputSignal (1, "", "", 0)
%assign u2i = LibBlockInputSignal (1, "", "", 1)
%assign yr  = LibBlockOutputSignal (0, "", "", 0)
%assign yi  = LibBlockOutputSignal (0, "", "", 1)
%if (LibBlockInputSignalBufferDstPort(0) != -1)
  %% The first input is going to be overwritten by yr so
  %% we need to save the real part in a temporary variable.
  {
  real_T tmpRe = %<u1r>;
%assign u1r = "tmpRe";
%endif
%<yr> = %<u1r> * %<u2r> - %<u1i> * %<u2i>;
%<yi> = %<u1r> * %<u2i> + %<u1i> * %<u2r>;
%if (LibBlockInputSignalBufferDstPort(0) != -1)

 Advanced Functions

22-71



  }
%endif

Note that, because only one output port exists, this example could have used
(LibBlockInputSignalBufferDstPort(0) == 0) as the Boolean condition for the %if
statements.

See LibBlockInputSignalBufferDstPort in blkiolib.tlc.

LibBlockInputSignalStorageClass(portIdx, sigIdx)
Returns the storage class of the specified block input port signal. The storage class can be "Auto",
"ExportedSignal", "ImportedExtern", or "ImportedExternPointer".

See LibBlockInputSignalStorageClass in blkiolib.tlc.

LibBlockInputSignalStorageTypeQualifier(portIdx, sigIdx)
Returns the storage type qualifier of the specified block input port signal. The type qualifier can be
anything entered by the user, such as const. The default type qualifier is "Auto", which means do
the default action.

See LibBlockInputSignalStorageTypeQualifier in blkiolib.tlc.

LibBlockOutputSignalIsGlobal(portIdx)

Returns 1 if the specified block output port signal is declared in the global scope, otherwise returns
0.

If LibBlockOutputSignalIsGlobal returns 1, then the variable holding this signal is accessible
from anywhere in generated code. For example, LibBlockOutputSignalIsGlobal returns 1 for
signals that are test points, external, or invariant.

See LibBlockOutputSignalIsGlobal in blkiolib.tlc.

LibBlockOutputSignalIsInBlockIO(portIdx)

Returns 1 if the specified block output port exists in the global block I/O data structure. You might
need to use this if you specify ssSetOutputPortReusable(S,portIdx,TRUE) in your S-function.

See sfun_multiport.tlc.

See LibBlockOutputSignalIsInBlockIO in blkiolib.tlc.

LibBlockOutputSignalIsValidLValue(portIdx)

Returns 1 if the specified block output port signal can be used as a valid left-side argument (lvalue)
in an assignment expression, otherwise returns 0. For example,
LibBlockOutputSignalIsValidLValue returns 1 if the block output port signal is in read/write
memory.
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See LibBlockOutputSignalIsValidLValue in blkiolib.tlc.

LibBlockOutputSignalStorageClass(portIdx)

Returns the storage class of the block's specified output signal. The storage class can be "Auto",
"ExportedSignal", "ImportedExtern", or "ImportedExternPointer".

See LibBlockOutputSignalStorageClass in blkiolib.tlc.

LibBlockOutputSignalStorageTypeQualifier(portIdx)

Returns the storage type qualifier of the block's specified output signal. The type qualifier can be
anything entered by the user, such as const. The default type qualifier is Auto, which means do the
default action.

See LibBlockOutputSignalStorageType in blkiolib.tlc.

LibBlockSrcSignalBlock(portIdx, sigIdx)

Returns a reference to the block that is the source of the specified block input port element. The
return argument is one of the following:

[systemIdx, blockIdx] If the block output or state is unique
"ExternalInput" If external input (root inport)
"Ground" If unconnected or connected to ground
"FcnCall" If function-call output
0 If not unique (i.e., source for a Merge block or a

signal reused because of block I/O optimization)

Example

The following code fragment finds the block that drives the second input on the first port of the
current block, then assigns the input signal of this source block to the variable y:

%assign srcBlock = LibBlockSrcSignalBlock(0, 1)
%% Make sure that the source is a block
%if TYPE(srcBlock) == "Vector"
  %assign sys = srcBlock[0]
  %assign blk = srcBlock[1]
  %assign block = CompiledModel.System[sys].Block[blk]
  %with block
    %assign u = LibBlockInputSignal(0, "", "", 0)
    y = %<u>;
  %endwith
%endif

See LibBlockSrcSignalBlock in blkiolib.tlc.
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LibBlockSrcSignalIsDiscrete(portIdx, sigIdx)

Returns 1 if the source signal corresponding to the specified block input port element is discrete,
otherwise returns 0.

Note that LibBlockSrcSignalIsDiscrete also returns 0 if the driving block cannot be uniquely
determined to be a merged or reused signal (i.e., the source is a Merge block or the signal has been
reused because of optimization).

See LibBlockSrcSignalIsDiscrete in blkiolib.tlc.

LibBlockSrcSignalIsGlobalAndModifiable(portIdx, sigIdx)

LibBlockSrcSignalIsGlobalAndModifiable returns 1 if the source signal corresponding to the
specified block input port element satisfies the following three conditions:

• It is readable everywhere in the generated code.
• It can be referenced by its address.
• Its value can change (i.e., it is not declared as a const).

Otherwise, LibBlockSrcSignalIsGlobalAndModifiable returns 0.

See LibBlockSrcSignalIsGlobalAndModifiable in blkiolib.tlc.

LibBlockSrcSignalIsInvariant(portIdx, sigIdx)

Returns 1 if the source signal corresponding to the specified block input port element is invariant
(i.e., the signal does not change).

For example, a source block with a constant TID (or equivalently, an infinite sample time) would
output an invariant signal.

See LibBlockSrcSignalIsInvariant in blkiolib.tlc.

LibGetModelReferenceUserData(modelName)
Gets the user data for the given model. This returns a vector with one element for each time
LibAppendToUserData is called in the given model. This function cannot be called during builds
where the target type is SIM.

See LibGetModelReferenceUserData in modelrefutil.tlc.

LibGetReferencedModelNames()
Gets the names of the models referenced by the model that is currently being built. Returns the data
as a structure with two fields:

• NumReferencedModels: an integer with the number of model names
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• ReferencedModel: an array of structures, where each structure has a field –Name– containing
the name of a referenced model

See LibGetReferencedModelNames in modelrefutil.tlc.

LibIsModelReferenceRTWTarget()
Returns true if the build process is generating code for model reference target.

See LibIsModelReferenceRTWTarget in utillib.tlc.

LibIsModelReferenceSimTarget()
Return true if we are generating code for model reference Simulation target.

See LibIsModelReferenceSimTarget in utillib.tlc.

LibIsModelReferenceTarget()
Return true if we are generating code for model reference target.

See LibIsModelReferenceTarget in utillib.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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Block Compatibility Functions

LibBlockSetIsExpressionCompliant(block)
Specify that a block's TLC file is compliant with expression folding. Call this function from within the
BlockInstanceSetup function. The input to this function is the block record.

See LibBlockSetIsExpressionCompliant(block) in block_api.tlc.

LibBlockSetIntegerDowncastUnnecessary(block)
Specify that this block does not need to enforce integer downcasts for its output expression. The
input to this function is the block record.

See LibBlockSetIntegerDowncastUnnecessary(block) in block_api.tlc.

LibBlockSetCustomStorageComplianceLevel (block, level)
Set the custom storage compliance level of a block.

The inputs to this function are the block record and the custom storage class compliance level. The
possible levels are as follows:

• 0—The block does not support custom storage classes.
• 1— The block supports level 1 custom storage classes. Level 1 custom storage classes do not

support the set method.
• 2—The block supports level 1 and 2 custom storage classes. Level 2 custom storage classes

include level 1 custom storage classes and those that implement a set method.

See LibBlockSetCustomStorageComplianceLevel(block,level) in block_api.tlc.

See Also

Related Examples
• “Target Language Compiler Library Functions Overview” on page 22-2
• “Target Language Compiler Function Conventions” on page 22-3
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TLC Error Handling
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TLC Error Handling

Error Reporting
You might need to detect and report error conditions in your TLC code. Error detection and reporting
are used most often in library functions. While rare, it is also possible to encounter error conditions in
block target file code if the S-function mdlCheckParameters function does not detect an unforeseen
condition.

To report an error condition detected in your TLC code, use the LibBlockReportError or
LibBlockReportFatalError utility functions. Here is an example of using
LibBlockReportError in the paramlib.tlc function LibBlockParameter to report the
condition of an improper use of that function:
%if TYPE(param.Value) == "Matrix"
    %% exit if the parameter is a true matrix,
    %% i.e., has more than one row or columns.
    %if nRows > 1
      %assign errTxt = "Must access parameter %<param.Name> using "...
        "LibBlockMatrixParameter."
      %<LibBlockReportError([], errTxt)>
    %endif
  %endif

Browse through the files in the folder matlabroot/rtw/c/tlc (open) for more examples of the use
of LibBlockReportError.

Generating Errors from TLC Files
TLC Error Generation Overview

To generate errors from TLC files, you can use the %exit directive. Alternatively, you can use one of
the library functions described below that calls %exit for you. The two types of errors are

Usage errors These can be caused by incorrect models.
Fatal (internal) TLC coding errors These cannot be caused by incorrect models.

Usage Errors

Usage errors are errors resulting from incorrect models or attributes defined on a model. For
example, suppose you have an S-Function block and an inline TLC file for a specific D/A device. If a
model can contain only one copy of this S-function, then an error needs to be generated for a model
that contains two copies of this S-Function block.
Using Library Functions

To generate usage errors related to a specific block, use the library function

LibBlockReportError(block,"error string")

The block argument is the block record if it isn't scoped. If the block is currently scoped, then you
can specify block as [ ].

To generate general usage errors that are not related to a specific block, use

LibReportError("error string")
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These library functions prefix the string Simulink Coder Error: to the message you provide when
reporting the error.

For a usage example of these functions, refer to gensfun.tlc for block errors and
commonsetup.tlc for common errors. There are other files that use these functions in the TLC
source folders within matlabroot/rtw/c/tlc (open.

Fatal (Internal) TLC Coding Errors

Suppose you have an S-function that has a local function that can accept only numerical numbers.
You might want to add an assert requiring that the inputs be only numerical numbers. These asserts
can indicate fatal coding errors for which the user does not have a way of building a model or
specifying attributes that can cause the error to occur.
Using Library Functions

The two available library functions are

LibBlockReportFatalError(block,"fatal coding error message")

where block is the offending block record (or [] if the block is already scoped), and

LibReportFatalError("fatal coding error message")

for error messages that are not block specific. For example, to add assert code you could use

%if TYPE(argument) != "Number" 
  %<LibBlockReportFatalError(block,"unexpected argument type")>
%endif

These library functions prefix the string Simulink Coder Fatal: to the message you provide and
display the call stack when reporting the error.

For a usage example of these functions, refer to gensfun.tlc for block errors and
commonsetup.tlc for common errors. There are other files that use these functions in the folder
matlabroot/rtw/c/tlc (open).
Using %exit

You can call %exit to generate fatal error messages. However, MathWorks suggests that you use one
of the library functions described above.

When generating fatal error messages directly with %exit, it is good practice to give a stack trace
with the error message. This lets you see the call chain of functions that caused the error. To
generate a stack trace, generate the message using the format:

%setcommandswitch "-v1"
%exit Simulink Coder Fatal: error string

Formatting Error Messages

If you want to display a formatted, multiple-line error message, create a local variable that contains
the message text. For example:

%openfile message
My message text
with newlines
%closefile message
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After formatting your error message, use one of the error reporting library functions described above,
such as LibReportError, to report your error when it occurs. For example:

%<LibReportError(message)>

The error reporting library functions provide an error message prefix, such as Simulink Coder
Error:.

Testing Error Messages

It is strongly suggested that you test your error messages before releasing your new TLC code. To
test your error messages, copy the relevant code into a test.tlc file and run

tlc test.tlc

at the MATLAB prompt.

Using TLC Error Messages to Troubleshoot
This section lists and describes error messages generated by the Target Language Compiler. Use this
reference to

• Confirm that an error has been reported
• Determine possible causes for an error
• Determine possible ways to fix an error

%closefile or %selectfile or %flushfile argument must be a valid open
file
In %closefile or %selectfile or %flushfile, the argument must be a valid file variable opened
with %openfile.

%define no longer supported, use %function instead
Macros are not supported. You must rewrite macros as functions or inline them in your code.

%error directive: text
Code containing the %error directive generates this message. It normally indicates some condition
that the code was unable to handle and displays the text following the %error directive.

%exit directive: text
Code containing the %exit directive causes this message. It typically indicates some condition that
the code was unable to handle and displays the text following the %exit directive. Note that this
directive causes the Target Language Compiler to terminate regardless of the -mnumber command-
line option.

%filescope has already been used in this file
The user attempted to use the %filescope directive more than once in a file.
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%trace directive: text
The %trace directive produces this error message and displays the text following the %trace
directive. Trace directives are reported only when the -v option (verbose mode) appears on the
command line. Note that %trace directives are not considered errors and do not cause the Target
Language Compiler to stop processing.

%warning directive: text
The %warning directive produces this error message and displays the text following the %warning
directive. Note that %warning directives are not considered errors and do not cause the Target
Language Compiler to stop processing.

A %implements directive must appear within a block template file and
must match the %language and type specified
A block template file was found, but it did not contain an %implements directive. An %implements
directive is required so that the expected language and type are implemented by this block template
file. See “Object-Oriented Facility for Generating Target Code” on page 19-23 for more information.

A %switch statement can only have one %default
The user has written a %switch statement with multiple %default cases, as in the following
example:

%switch expr
  %case 1
    code...
    %break
  %default
    
more code...
    %break
  %default          %% error
    even more code...
    %break
%endswitch

A language choice must be made using the %language directive prior
to using GENERATE or GENERATE_TYPE
To use the GENERATE or GENERATE_TYPE built-in functions, the Target Language Compiler requires
that you first specify the language being generated. This causes the block-level target file to
implement the same language and type as specified in the %language directive.

A non-homogeneous vector was passed to
GENERATE_FORMATTED_VALUE
The built-in GENERATE_FORMATTED_VALUE can process only vectors that have homogeneous
elements (that is, vectors in which all the elements have the same type).
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Ambiguous reference to identifier — must use array index to refer to
one of multiple scopes
In a repeated scope identifier from a database file, you must specify an index to disambiguate the
reference. For example

Database file:
block
{
    Name                "Abc2"
    Parameter {
        Name            "foo"
        Value            2
    }
}
block
{
    Name                "Abc3"
    Parameter {
        Name            "foo"
        Value            3
    }
}
TLC file:
%<GETFIELD(block, "Name")>

In the preceding example, the reference to block is ambiguous because multiple repeated scopes
named block appear in the database file. Use an index to disambiguate the references, as in:

%<GETFIELD(block[0], "Name")>

An %if statement can only have one %else
The user has written an %if statement with multiple %else blocks, as in the following example:

%if expr
  code...
%else
  more code...
%else          %% error
  even mode code...
%endif

Argument to identifier must be a string
The following built-in functions expect a string and report this error if the argument passed is not a
string.

CAST GENERATE_FILENAME
EXISTS GENERATE_FUNCTION_EXISTS
FEVAL GENERATE_TYPE
FILE_EXISTS GET_COMMAND _SWITCH
FORMAT IDNUM
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GENERATE SYSNAME

Arguments to directive must be records
Arguments to %mergerecord and %copyrecord must be records. Also, the first argument to the
following built-in functions must be a record:

• ISALIAS
• REMOVEFIELD
• FIELDNAMES
• ISFIELD
• GETFIELD
• SETFIELD

Arguments to TLC from the MATLAB command line must be strings
An attempt was made to invoke the Target Language Compiler from MATLAB, but some of the
arguments that were passed were not strings.

Assertion failed
An expression in an %assert statement evaluated to false.

Assignment to scope identifier is only allowed when using the +
operator to add members
Scope assignment must be scope = scope + variable.

Attempt to define a function identifier on top of an existing variable
or function
A function cannot be defined twice. Make sure that you don't have the same function defined in
separate TLC files.

Attempt to divide by zero
The Target Language Compiler does not allow division by zero.

Bad cast - unable to cast this expression to type
The Target Language Compiler cannot cast this expression from its current type to the specified type.
For example, the Target Language Compiler cannot cast a string to a number, as in

%assign x = "1234"
%assign y = CAST("Number", x );
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Bad directory (dirname) in O: filename
The -O option did not specify a valid folder.

builtin was expecting expression of type type, got one of type type
A built-in was passed an expression of incorrect type.

Cannot %undef any builtin functions or variables
User is not allowed to undefine a TLC built-in or variable. For example

%undef FORMAT  %% error

Cannot convert string your_string to a number
Cannot convert the string to a number.

Changing value of identifier from the RTW file
You have overwritten the value that appeared in the .rtw file.

Error opening filename
The Target Language Compiler could not open the file specified on the command line.

Error writing to file error
There was an error while writing to the current output stream; error contains the system specific
error message.

Errors occurred — aborting
This error message is the last error to be reported. It occurs when either

• The number of error messages exceeds the error message threshold (5 by default).
• Processing completes and errors have occurred.

Expansion directives %<> cannot be nested
It is illegal to nest expansion directives. For example,

%<foo(%<expr>)>

Instead, do the following:

%assign tmp = %<expr>
%<foo(tmp)>
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Expansion directives %<> cannot span multiple lines; use \ at end of
line
An expansion directive cannot span multiple lines. To work around this restriction, use the \ line
continuation character. The following is incorrect:

%<CompiledModel.System[Sysidx].Block[BlkIdx].Name + 
"Hello">

Instead, use:

%<CompiledModel.System[Sysidx].Block[BlkIdx].Name + \
"Hello">

Extra arguments to the function-name built-in function were ignored
(Warning)
The following built-in functions report this warning when too many arguments are passed to them:

CAST NUMTLCFILES
EXISTS OUTPUT_LINES
FILE_EXISTS SIZE
FORMAT STRING
GENERATE_FILENAME STRINGOF
GENERATE_FUNCTION_EXISTS SYSNAME
IDNUM TLCFILES
ISFINITE TYPE
ISINF WHITE_SPACE
ISNAN WILL_ROLL

File name too long (directory =dirname, name =filename)
The specified filename was too long. The default limits are 256 characters for filename and 1024
characters for dirname, but the limits can be larger, depending on the platform.

format is not a legal format value
The specified format was not legal for the %realformat directive. Valid format strings are
"EXPONENTIAL" and "CONCISE".

Function argument mismatch; function function_name expects
number arguments
When calling a function, too many or too few arguments were passed to it.
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Function reached the end and did not return a value
Functions that are not declared as void or Output must return a value. If a return value is not
desired, declare the function as void, otherwise make it return a value.

Function values are not allowed
Attempt to use a TLC function as a variable.

Identifier identifier multiply defined. Second and succeeding
definitions ignored.
The user is attempting to add the same field to a record more than once, as in the following code.

%createrecord err { foo 1; rec { val 2 } }
%addtorecord err foo 2             %% error

Identifier identifier used on a %foreach statement was already in
scope (Warning)
The argument to a %foreach statement cannot be defined prior to entering the %foreach.

Illegal use of eval (i.e., %<...>)
It is illegal to use evals in .rtw files. There are also some places where evals are not allowed in
directives. For example:

%function %<foo>(a, b, c) void  %% error
%endfunction

Indices may not be negative
An index used in a [ ] expression must be a nonnegative integer.

Indices must be constant integral numbers
An index used in a [ ] expression must be an integer number.

Invalid handle
An invalid handle was passed to the Target Language Compiler server mode.

Invalid identifier range, the leading strings string1 and string2 must
match
In a range of signals, for example, u1:u10, the identifier in the first argument did not match the
identifier in the second.
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Invalid identifier range, the lower bound (bound) must be less than
the upper bound (bound)
In a range of signals, for example, u1:u10, the lower bound was higher than the upper bound.

Invalid type for unary operator
Unary operators – and + require numeric types. Unary operator – requires an integral type. Unary
operator ! requires a numeric type.

Invalid type type
An invalid type was passed to a built-in function.

It is illegal to return a function from a function
A function value cannot be returned from a function call.

Named value identifier already exists within this scope-identifier; use
%assign to change the value
You cannot use the block addition operator + to add a value that is already a member of the indicated
block. Use %assign to change the value of an existing value. This example produces this error:

%assign x = BLK { a 1; b 2 }
%assign a = 3
%assign x = x + a

Use this instead:

%assign x.a = 3

No %case statement(s) seen yet, statement ignored
Statements that appear inside a %switch statement but precede %case statements are ignored, as in
the following code:

%switch expr
%assign x = 2  %% this statement will be ignored
  %case 1
    code
    %break
%endswitch

Only double and character arrays can be converted from MATLAB to
TLC. This can occur if the MATLAB function does not return a value
(see %matlab)
Only double and character arrays can be converted from MATLAB to the Target Language Compiler.
This error can occur if the MATLAB function does not return a value (see %matlab). For example,
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%assign a = FEVAL("int8",3)
%matlab disp(a)

Only one output is allowed from the TLC
An attempt was made to receive multiple outputs from the MATLAB version of the Target Language
Compiler.

Only strings of length 1 can be assigned using the [ ] notation
The right-hand side of a string assignment using the [ ] operator must be a string of length 1. You can
replace only a single character using this notation.

Only strings or cells of strings may be used as the argument to Query
and ExecString
A cell containing nonstring data was passed as the third argument to Query or ExecString in server
mode.

Only vectors of the same length as the existing vector value can be
assigned using the [ ] notation
In the [ ] notation to replace a row of a matrix, the row must be a vector of the same length as the
existing rows.

Output file identifier opened with %openfile was not closed
Output files opened with %openfile must be closed with %closefile. The identifier is the
name of the variable specified in the %openfile directive.

Note This might also occur a syntax error is present in a code section between an openfile and
closefile, or if you try to assign the output of a function of type void or Output to a variable.

Ranges, identifier ranges, and repeat values cannot be repeated
You cannot repeat a range, identifier range, or repeat value. This prevents things like [1@2@3].

String cannot modify the setting for the command line switch '-switch'
%setcommandswitch does not recognize the specified switch, or cannot modify it (e.g., -r cannot be
modified).

string is not a recognized user defined property of this handle
The query performed on a TLC server mode handle is looking for an undefined property.
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Syntax error
The indicated line contains a syntax error, for more information on syntax, see “Target Language
Compiler Directives” on page 19-2.

The %break directive can only appear within a %foreach, %for, %roll,
or %switch statement
The %break directive can be used only in a %foreach, %for, %roll, or %switch statement.

The %case and %default directives can only be used within the
%switch statement
A %case or %default directive can appear only within a %switch statement.

The %continue directive can only appear within a %foreach, %for, or
%roll statement
The %continue directive can be used only in a %foreach, %for, or %roll statement.

The %foreach statement expects a constant numeric argument
The argument of a %foreach must be a numeric type. For example:

%foreach Index = [1 2 3 4]
...
%endforeach

%foreach cannot accept a vector as input.

The %if statement expects a constant numeric argument
The argument of an %if statement must be a numeric type. For example,

%if [ 1 2 3 ]
...
%endif

%if cannot accept a vector as input.

The %implements directive expects a string or string vector as the list
of languages
You can use the %implements directive to specify a string for the language being implemented, or to
indicate that it implements multiple languages by using a vector of strings. You cannot specify any
other argument type to the %implements directive.
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The %implements directive specifies type as the type where type was
expected
The type specified in the %implements directive must exactly match the type specified in the block
or on the GENERATE_TYPE directive. If you want to specify that the block accept multiple input types,
use the %implements * directive, as in

%implements * "C"   %% I accept any type and generate C code

The %implements language does not match the language currently
being generated (language)
The language or languages specified in the %implements directive must exactly match the
%language directive.

The %return statement can only appear within the body of a function
A %return statement can be only in the body of a function.

The == and != operators can only be used to compare values of the
same type
The == and != operator arguments must be the same type. You can use the CAST() built-in function
to change them into the same type.

The argument for %openfile must be a valid string
When you open an output file, the name specified for the file must be a valid string.

The argument for %with must be a valid scope
The argument to %with must be a valid scope identifier. For example,

%assign x = 1
%with x
...
%endwith

In this code, the %with statement argument is a number and produces this error message.

The argument for an [ ] operation must be a repeated scope symbol, a
vector, or a matrix
When you use the [ ] operator to index, the expression on the left of the brackets must be a vector,
matrix, string, numeric constant, or a repeated scope identifier. When you use array indexing on a
scalar, the constant is automatically scalar expanded and the value of the scalar is returned. For
example,

%openfile x
%assign y = x[0]
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This example causes this error because x is a file and is not valid for indexing.

The argument to %addincludepath must be a valid string
The argument to %addincludepath must be a string.

The argument to %include must be a valid string
The argument to the input file control directive must be a valid string with the filename given in
double quotation marks.

The begin directive must be in the same file as the corresponding end
directive.
These Target Language Compiler begin directives must appear in the same file as their
corresponding end directives: %function, %switch, %foreach, %roll, and %for. Place the
construct entirely within one Target Language Compiler source file.

The begin directive on this line has no matching end directive
For block-scoped directives, this error is produced if a matching end directive is missing. This error
can occur for the following block-scoped Target Language Compiler directives.

Begin Directive End Directive Description
%if %endif Conditional inclusion
%for %endfor Looping
%foreach %endforeach Looping
%roll %endroll Loop rolling
%with %endwith Scoping directive
%switch %endswitch Switch directive
%function %endfunction Function declaration directive
{ } Record creation

The error is reported on the line that opens the scope and does not have matching end scope.

Note Nested scopes must be closed before their parent scopes. Failure to include an end for a
nested scope often causes this error, as in

%if Block.Name == "Sin 3" 
    %foreach idx = Block.Width %endif  
%% Error reported here that the %foreach was not terminated

The construct %matlab function_name(...) construct is illegal in
standalone tlc
You cannot call MATLAB from stand-alone TLC.
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The FEVAL() function can accept only 2-dimensional arrays from
MATLAB, not number dimensions
Return values from MATLAB can have at most two dimensions.

The FEVAL() function can accept vectors of numbers or strings only
when calling MATLAB
Vectors passed to MATLAB can be numbers or strings. See “FEVAL Function” on page 19-32.

The FEVAL() function requires the name of a function to call
FEVAL requires a function to call. This error appears only inside MATLAB.

The final argument to %roll must be a valid block scope
When you use %roll, the final argument (prior to extra user-specified arguments) must be a valid
block scope. See “%roll” on page 19-22 for a description of this command.

The first argument of a ? : operator must be a Boolean expression
The ? : operator must have a Boolean expression as its first operand.

The first argument to GENERATE or GENERATE_TYPE must be a valid
scope
When you call GENERATE or GENERATE_TYPE, the first argument must be a valid scope. See the
“GENERATE and GENERATE_TYPE Functions” on page 19-24 for more information and examples.

The function name requires at least number arguments
User is passing too few arguments to a function, as in the following code:

%function foo(a, b, c)
  %return a + b + c
%endfunction

%<foo(1, 2)>  %% error

The GENERATE function requires at least 2 arguments
When you call the GENERATE built-in function, the first two arguments must be the block and the
name of the function to call.

The GENERATE_TYPE function requires at least 3 arguments
When you call the GENERATE_TYPE built-in function, the first three arguments must be the block, the
name of the function to call, and the type.
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The ISINF(), ISNAN(), ISFINITE(), REAL(), and IMAG() functions expect
a real or complex valued argument
These functions expect a Real or complex value as the input argument.

The language being implemented cannot be changed within a block
template file
You cannot change the language using the %language directive within a block template file.

The language being implemented has changed from old-language to
new-language (Warning)
The language being implemented should not be changed in midstream because GENERATE function
calls that appear prior to the %language directive can cause generate functions to load for the
prior language. Only one language directive should appear in a given file.

The left-hand side of a . operator must be a valid scope identifier
When you use the . operator, the left-hand side of the . operator must be a valid in-scope identifier.
For example:

%assign x = 1
%assign y = x.y

In this code, the reference to x.y produces this error message because x is not defined as a scope.

The left-hand side of an assignment must be a simple expression
comprised of ., [ ], and identifiers
Illegal left-hand side of assignment.

The number of columns specified (specified-columns) did not match
the actual number of columns in the rows (actual-columns)
When you specify a Target Language Compiler matrix, the number of columns specified must match
the actual number of columns in the matrix. For example,

%assign mat = Matrix(2,1) [[1,2];[2,3]]

In this case, the number of columns in the declaration of the matrix (1) did not match the number of
columns seen in the matrix (2). Either change the number of columns in the matrix, or change the
matrix declaration.

The number of rows specified (specified-rows) did not match the
actual number of rows seen in the matrix (actual-rows)
When you specify a Target Language Compiler matrix, the number of rows must match the actual
number of rows in the matrix. For example,
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%assign mat = Matrix(1,2) [[1,2];[2,3]]

In this case, the number of rows in the declaration of the matrix (1) did not match the number of rows
seen in the matrix (2). Either change the number of rows in the matrix or change the matrix
declaration.

The operator_name operator only works on Boolean arguments
The && and || operators work only on Boolean values.

The operator_name operator only works on integral arguments
The &, ^, |, <<, >> and % operators work on numbers only.

The operator_name operator only works on numeric arguments
The arguments to the following operators both must be either numeric or real: <, <=, >, >=, -, *, /.
This error can also occur when you use + as a unary operator. In addition, the FORMAT built-in
function expects either a numeric or real argument.

The return value from the RollHeader function must be a string
When you use %roll, the RollHeader() function specified in Roller.tlc must return a string
value. See “%roll” on page 19-22 for a complete discussion of the %roll construct.

The roll argument to %roll must be a nonempty vector of numbers or
ranges
When you use %roll, the roll vector cannot be empty and must contain numbers or ranges of
numbers. See “%roll” on page 19-22 for a complete discussion of the %roll construct.

The second value in a Range must be greater than the first value
In a range, for example, 1:10, the lower bound was higher than the upper bound.

The specified index (index) was out of the range 0 - number-of-
elements - 1
This error occurs when you index into a nonscalar beyond the end of the variable. For example:

%assign x = [1 2 3]
%assign y = x[3]

This example would cause this error. Remember, in the Target Language Compiler, array indices start
at 0 and go to the number of elements minus 1.

A TLC Error Handling

A-18



The STRINGOF built-in function expects a vector of numbers as its
argument
The STRINGOF function expects a vector of numbers. The function treats each number as the ASCII
value of a valid character.

The SYSNAME built-in function expects an input string of the form
xxx/yyy
The SYSNAME function takes a single string of the form xxx/yyy as it appears in the .rtw file and
returns a vector of two strings, xxx and yyy. If the input argument does not match this format,
SYSNAME returns this error.

The threshold on a %roll statement must be a single number
When you use %roll, the roll threshold specified must be a single number. See “%roll” on page 19-22
for a complete discussion of the %roll construct.

The use of feature is being deprecated and will not be supported in
future versions of TLC. See the TLC manual for alternatives.
The %define and %generate directives are not recommended, as they are being replaced.

The WILL_ROLL built in function expects a range vector and an integer
threshold
The WILL_ROLL function requires both arguments cited in the message.

There are no more free contexts. Use tlc('close', HANDLE) to free up a
context
The global context table has filled up while the TLC server mode is in use.

There was no type associated with the given block for GENERATE
The scope specified to GENERATE must include a Type parameter that indicates which template file
should be used to generate code for the specified scope. For example:

%assign scope = block { Name "foo" }
%<GENERATE( scope, "Output" )>

This example produces the error message because the scope does not include the parameter Type.
See the “GENERATE and GENERATE_TYPE Functions” on page 19-24 for more information and
examples.
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This assignment would overwrite an identifier-value pair from the
RTW file. To avoid this error either qualify the left-hand side, or
choose another identifier.
The user is trying to modify a field of a record in a %with block without qualifying the left-hand side,
as in this example:

  %createrecord foo { field 1 }
  %with foo
    %assign field = 2  %% error
  %endwith

Instead, use

%createrecord foo { field 1 }
  %with foo
    %assign foo.field = 2
  %endwith

TLC has leaked number symbols. You may have created a cyclic
record. If this not the case then please report this leak to The
MathWorks.
There has been a memory leak while running TLC. The most common cause of this is having cyclic
records.

Unable to find identifier within the scope-identifier scope
The given identifier was not found in the scope specified. For example,

%assign scope = ascope { x 5 }
%assign y = scope.y

In this code, the reference to scope.y produces this error message.

Unable to open %include file filename
The file included in an %include directive was not found on the path. Either move the file to a
location on the current path, or use the -I command-line option or the %addincludepath directive
to specify the folder that contains the file.

Unable to open block template file filename from GENERATE or
GENERATE_TYPE
You specified GENERATE but the given filename was not found on the Target Language Compiler path.
You can

• Add the file to a folder on the path.
• Use the %generatefile directive to specify an alternative filename for this block type that is on

the path.
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• Add the folder in which this file appears to the search path using the -I command-line option or
the %addincludepath directive.

Unable to open output file filename
The specified output file could not be opened. Either an invalid filename was specified or the file was
read only.

Undefined identifier identifier_name
The identifier specified in this expression was undefined.

Unknown type type in CAST expression
When you call the CAST built-in function, the type must be a valid type from the “Target Language
Value Types” on page 19-13 table.

Unrecognized command line switch passed to string: switch
You queried the current state of a switch, but the switch specified was not recognized.

Unrecognized directive directive-name seen
An illegal % directive was encountered. The valid directives are shown below.

%addincludepath %addtorecord
%assert %assign
%break= %case
%closefile %continue
%copyrecord %createrecord
%default %define
%else %elseif
%endbody %endfor
%endforeach %endfunction
%endif %endroll
%endswitch %endwith
%error %exit
%filescope %for
%foreach %function
%generate %generatefile
%if %implements
%include %language
%matlab %mergerecord
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%openfile %realformat
%return %roll
%selectfile %setcommandswitch
%switch %trace
%undef %warning
%with  

Unrecognized type output-type for function
The function type modifier was not Output or void. For functions that do not produce output, the
default without a type modifier indicates that the function should not produce output.

Unterminated multiline comment.
A multiline comment (i.e., /% %/) does not have a terminator, as in the following code:

/% my comment

%assign x = 2
%assign y = x * 7

Unterminated string
A string must be closed prior to the end of an expansion directive or the end of a line.

Usage: tlc [options] file
A command-line problem has occurred. The error message contains a list of the available options.

Use of feature incurs a performance hit, please see TLC manual for
possible workarounds.
The %undef and expansion (i.e., %<expr>) features can degrade performance.

Value of type type cannot be compared
Values of the specified type cannot be compared.

Values of specified_type type cannot be expanded
The specified type cannot be used on an expansion directive. Files and scopes cannot be expanded.
This error can also occur when you expand a function without any arguments. If you use

%<Function>

call it with the required arguments.
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Values of type Special, Macro Expansion, Function, File, Full Identifier,
and Index cannot be converted to MATLAB variables
Values of the types listed in the message cannot converted to MATLAB variables.

When appending to a buffer stream, the variable must be a string
You can specify the append option for a buffer stream only if the variable currently exists as a string.
Do not use the append option if the variable does not exist or is not a string. This example produces
this error.

%assign x = 1
%openfile x , "a"
%closefile x

TLC Function Library Error Messages
The functions in the TLC function library can generate many error messages that are not
documented. These messages are sufficiently self-descriptive so that they do not need additional
explanation. However, if you encounter an error message that does not provide enough description to
resolve your problem, contact our technical support staff.

See Also

Related Examples
• “Target Language Compiler Directives” on page 19-2
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Guidelines and Standards for Embedded
Coder

• “Support for Standards and Guidelines” on page 23-2
• “MAB Guidelines” on page 23-4
• “MISRA C Guidelines” on page 23-5
• “Secure Coding Standards” on page 23-6
• “High-Integrity System Modeling Guidelines” on page 23-7
• “Modeling Guidelines for Code Generation” on page 23-8
• “IEC 61508 Standard” on page 23-9
• “IEC 62304 Standard” on page 23-11
• “ISO 26262 Standard” on page 23-12
• “EN 50128 Standard” on page 23-13
• “ISO 25119 Standard” on page 23-14
• “DO-178C Standard” on page 23-15
• “AUTOSAR Standard” on page 23-17
• “Develop a Model that Complies with the AUTOSAR Standard” on page 23-18
• “Develop a Model that Complies with the IEC 61508 Standard” on page 23-24
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Support for Standards and Guidelines
If your application has safety-critical development and certification goals, your models or subsystems
and the code generated for them might need to comply with one or more of the standards and
guidelines listed in the following table.

Standard or Guidelines Organization For More Information, See...
MathWorks Advisory Board (MAB)
Guidelines

MathWorks with NA-MAAB and
JMAAB standards groups

• “MAB Modeling Guidelines”
• Develop Models and Code that

Comply with “MAB Guidelines” on
page 23-4

Use of the C Language in Critical
Systems (MISRA C®)

Motor Industry Software
Reliability Association (MISRA)

• MISRA C website
• Develop Models and Code that

Comply with “MISRA C Guidelines”
on page 23-5

CERT® C Coding Standards CERT Division of the Software
Engineering Institute (SEI)

• CERT C Coding Standards
publication on the Software
Engineering Institute website

• Secure Coding on the Software
Engineering Institute website

• Develop Model and Code that
Comply with “Secure Coding
Standards” on page 23-6

Common Weakness Enumeration
(CWE™)

The MITRE Corporation • CWE list of software weaknesses
types

• Develop Model and Code that
Comply with “Secure Coding
Standards” on page 23-6

ISO/IEC TS 17961, Information
Technology — Programming
Languages, Their Environments
And System Software Interfaces —
C Secure Coding Rules

International Organization for
Standardization and International
Electrotechnical Commission

• ISO/IEC TS 17961:2013 standards
publication

• Develop Model and Code that
Comply with “Secure Coding
Standards” on page 23-6

AUTomotive Open System
ARchitecture (AUTOSAR)

AUTOSAR Development
Partnership

• Publications and specifications
available from the AUTOSAR
website

• AUTOSAR Support from Embedded
Coder on the MathWorks website

• “AUTOSAR Standard” on page 23-
17

• “AUTOSAR Blockset”
documentation
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https://www.mathworks.com/solutions/mab-guidelines.html
https://www.mathworks.com/solutions/mab-guidelines.html
https://www.misra.org.uk/
https://www.misra.org.uk/
https://www.misra.org.uk/
https://www.cert.org/
https://www.cert.org/
https://www.securecoding.cert.org/confluence/display/c/SEI+CERT+C+Coding+Standard
https://www.cert.org/secure-coding/
https://www.mitre.org/
https://cwe.mitre.org/data/index.html
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Standard or Guidelines Organization For More Information, See...
IEC 61508, Functional safety of
electrical/electronic/
programmable electronic safety-
related systems

International Electrotechnical
Commission

• IEC functional safety website
• IEC 61508 Support in MATLAB and

Simulink
• Develop Models and Code that

Comply with “IEC 61508 Standard”
on page 23-9

Standard: IEC 62304, Medical
device software — Software life
cycle processes

International Electrotechnical
Commission

• Develop Models and Code that
Comply with “IEC 62304 Standard”
on page 23-11

ISO 26262, Road Vehicles —
Functional Safety

International Organization for
Standardization

• ISO 26262 Support in MATLAB and
Simulink

• Develop Models and Code that
Comply with “ISO 26262 Standard”
on page 23-12

EN 50128, Railway applications —
Software for railway control and
protection systems

European Committee for
Electrotechnical Standardization

• Develop Models and Code that
Comply with “EN 50128 Standard”
on page 23-13

ISO 25119, Tractors and
machinery for agriculture and
forestry — Safety-related parts of
control systems

International Organization for
Standardization

• Develop Models and Code that
Comply with “ISO 25119 Standard”
on page 23-14

DO-178C, Software Considerations
in Airborne Systems and
Equipment Certification

Radio Technical Commission for
Aeronautics (RTCA)

• Develop Models and Code that
Comply with “DO-178C Standard”
on page 23-15
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MAB Guidelines
MathWorks Advisory Board (MAB) guidelines stipulate important basic rules for modeling in Simulink
and Stateflow. The overall purpose of these modeling guidelines is to allow for a simple, common
understanding by modelers and consumers of control system models. The main objectives of these
guidelines are readability, simulation and verification, and code generation.

To review the guidelines, see “MAB Modeling Guidelines”.

If you have a Simulink Check license, you can check that your Simulink model or subsystem, and the
code that you generate from it, complies with MAB guidelines. To check your model or subsystem:

1 Open the Model Advisor
2 Navigate to By Task > Modeling Standards for MAB.
3 Run the checks in the folder.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.
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MISRA C Guidelines
The Motor Industry Software Reliability Association (MISRA3) has established guidelines for the use
of the C Language in Critical Systems (MISRA C).

For information about MISRA C, see www.misra.org.uk.

In 1998, MIRA Ltd. published MISRA C (MISRA C:1998) to provide a restricted subset of a
standardized, structured language that met Safety Integrity Level (SIL) 2 and higher. A major update
based on feedback was published in 2004 (MISRA C:2004), followed by a minor update in 2007
known as Technical Corrigendum (TC1).

In 2007, MIRA Ltd. published the MISRA AC AGC standard, “MISRA AC AGC: Guidelines for the
Application of MISRA-C:2004 in the Context of Automatic Code Generation.” MISRA AC AGC does not
change MISRA C:2004 rules, rather it modifies the adherence recommendation.

In 2013, MIRA Ltd. published the MISRA C:2012 standard, “Guidelines for the use of the C language
in critical systems.” MISRA C:2012 provides improvements based on user feedback and includes
guidance on automatic code generation.

Embedded Coder and Simulink offer capabilities to minimize the potential for MISRA C rule
violations. Capabilities include:

• Code Generation Advisor, which helps you configure a model or subsystem so that the code
generator is most likely to produce MISRA C:2012 compliant code. For more information, see
“Configure Model for Code Generation Objectives by Using Code Generation Advisor” on page 47-
2.

• Model Advisor checks, which you can use as you developed your model or subsystem to increase
the likelihood of generating MISRA C:2012 compliant code. To execute the MISRA C:2012
compliance checks your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Guidelines for MISRA C:2012.
3 Run the checks in the folder.

For more information on using the Model Advisor, see “Check Your Model Using the Model
Advisor”.

When using MISRA C:2012 coding guidelines to evaluate the quality of your generated C code, you
are required per section 5.3 of the MISRA C:2012 Guidelines for the Use of C Language in Critical
Systems document to prepare a compliance statement for the project being evaluated. To assist you
in the development of this compliance statement, MathWorks evaluates the MISRA C:2012 guidelines
against C code generated by using Embedded Coder. The results of the evaluation are published as:

• Compliance Summary Tables on page 24-6, which identify the method used to obtain
compliance for each rule and directive.

• Deviations on page 24-25, which identify rules or directives that are not compliant.

For more information, see “Developing a MISRA C:2012 Compliance Statement” on page 24-2.

3. MISRA and MISRA C are registered trademarks of MIRA Ltd., held on behalf of the MISRA Consortium.
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Secure Coding Standards
These coding standards are for software developers to use in the development of code in the C
language:

• CERT® C — Published by the CERT Division of the Software Engineering Institute (SEI), these
guidelines help eliminate constructs with undefined behavior that can lead to unexpected results
at runtime and expose security weaknesses.

• Common Weakness Enumeration (CWE™) — Published by The MITRE Corporation, this list
identifies common software weakness types that can occur in software architecture, design, code,
or implementation. These weaknesses can lead to security vulnerabilities.

• ISO/IEC TS 19761:2013 — Published by International Organization for Standardization and
International Electrotechnical Commission, these rules are designed so that they can be enforced
by static analysis tools without excessive false positives.

If you have an Embedded Coder or Simulink Check product license, you can check that your Simulink
model or subsystem, and the code that you generate from it, conforms to these secure coding
standards. To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Guidelines for Secure Coding (CERT C, CWE, ISO/IEC TS

17961) .
3 Run the checks in the folder.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

If you have a Polyspace Bug Finder product license, you can evaluate your code against these secure
coding standards. For more information, see:

• “CWE Coding Standard and Polyspace Results” (Polyspace Bug Finder)
• “Check for Coding Standard Violations” (Polyspace Bug Finder)
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High-Integrity System Modeling Guidelines
The high-integrity system modeling guidelines provide model setting, block usage, and block
parameter considerations for creating models that are complete, unambiguous, robust, and verifiable.
Use these guidelines when you develop models and generate code for safety-critical systems, such as
in projects that need to comply with the DO-178C / DO-331, IEC 61508, IEC 62304, ISO 26262, or EN
50128 safety standards.

For more information, see “High-Integrity System Modeling”.

If you have a Simulink Check product license, you can use the Model Advisor to check for compliance
with the high-integrity modeling guidelines. To check your model or subsystem, open the Model
Advisor and execute the checks in these folders:

• By Task > Modeling Standards for DO-178C/DO-331 > High-Integrity Systems
• By Task > Modeling Standards for IEC 61508 > High-Integrity Systems
• By Task > Modeling Standards for IEC 62304 > High-Integrity Systems
• By Task > Modeling Standards for EN 50128 > High-Integrity Systems
• By Task > Modeling Standards for ISO 26262 > High-Integrity Systems

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

 High-Integrity System Modeling Guidelines
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Modeling Guidelines for Code Generation
Use the code generation guidelines when you develop models and generate code for embedded
systems using Model-Based Design with MathWorks products. The guidelines provide model setting,
block usage, and block parameter considerations that impact code generation.

The code generation guidelines for blocks include:

• “cgsl_0101: Zero-based indexing”
• “cgsl_0102: Evenly spaced breakpoints in lookup tables”
• “cgsl_0103: Precalculated signals and parameters”
• “cgsl_0104: Modeling global shared memory using data stores”
• “cgsl_0105: Modeling local shared memory using data stores”

The code generation guidelines for modeling patterns include:

• “cgsl_0201: Redundant Unit Delay and Memory blocks”
• “cgsl_0202: Usage of For, While, and For Each subsystems with vector signals”
• “cgsl_0204: Vector and bus signals crossing into atomic subsystems or Model blocks”
• “cgsl_0205: Signal handling for multirate models”
• “cgsl_0206: Data integrity and determinism in multitasking models”

The code generation guidelines for configuration parameters include:

• “cgsl_0301: Prioritization of code generation objectives for code efficiency”
• “cgsl_0302: Diagnostic settings for multirate and multitasking models”
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IEC 61508 Standard

In this section...
“Apply Simulink and Embedded Coder to the IEC 61508 Standard” on page 23-9
“Check for IEC 61508 Standard Compliance Using the Model Advisor” on page 23-9
“Validate Traceability” on page 23-9

Apply Simulink and Embedded Coder to the IEC 61508 Standard
Applying Model-Based Design to a safety-critical system requires extra consideration and rigor so
that the system adheres to defined safety standards. IEC 61508, Functional safety of electrical/
electronic/programmable electronic safety related systems, is such a standard. Because the standard
was published when most software was coded by hand, the standard needs to be mapped to Model-
Based Design technologies. For further information about MathWorks support for IEC 61508, see IEC
61508 Support in MATLAB and Simulink.

MathWorks provides an IEC Certification Kit product that you can use to certify MathWorks code
generation and verification tools for projects based on the IEC 61508 standard. For more information,
see https://www.mathworks.com/products/iec-61508/.

Check for IEC 61508 Standard Compliance Using the Model Advisor
If you have a Simulink Check product license, you can check that your Simulink model or subsystem
and the code that you generate from it complies with selected aspects of the IEC 61508 standard.

To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Standards for IEC 61508.
3 Run the IEC 61508 (Simulink Check) checks.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

Validate Traceability
Typically, applications that require certification require some level of traceability between
requirements, models, and corresponding code.

To... Use...
Associate requirements documents with
objects in Simulink models

The “Requirements Management Interface Setup”
(Simulink Requirements) that is available if you have a
Simulink Requirements license.

Trace model blocks and subsystems to
generated code

The “Model-to-Code Traceability” on page 77-10
option when generating an HTML report during the
code generation or build process.

 IEC 61508 Standard
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To... Use...
Trace generated code to model blocks and
subsystems

The “Code-to-Model Traceability” on page 77-8
option when generating an HTML report during the
code generation or build process.
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IEC 62304 Standard

Apply Simulink and Embedded Coder to the IEC 62304 Standard
Applying Model-Based Design to a safety-critical system requires extra consideration and rigor so
that the system adheres to defined safety standards. Standard: IEC 62304, Medical device software -
Software life cycle processes, is such a standard.

MathWorks provides an IEC Certification Kit product that you can use to certify MathWorks code
generation and verification tools for projects based on the IEC 62304 standard. For more information,
see IEC Certification Kit.

Check for IEC 62304 Standard Compliance Using the Model Advisor
If you have a Simulink Check product license, you can check that your Simulink model or subsystem
and the code that you generate from it complies with selected aspects of the IEC 62304 standard.

To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Standards for IEC 62304.
3 Run the IEC 62304 (Simulink Check) checks.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

 IEC 62304 Standard
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ISO 26262 Standard

In this section...
“Apply Simulink and Embedded Coder to the ISO 26262 Standard” on page 23-12
“Check for ISO 26262 Standard Compliance Using the Model Advisor” on page 23-12
“Validate Traceability” on page 23-12

Apply Simulink and Embedded Coder to the ISO 26262 Standard
Applying Model-Based Design to a safety-critical system requires extra consideration and rigor so
that the system adheres to defined functional safety standards. ISO 26262, Road Vehicles - Functional
Safety, is such a standard. For further information about MathWorks support for ISO 26262, see ISO
26262 Support in MATLAB and Simulink.

MathWorks provides an IEC Certification Kit product that you can use to qualify MathWorks code
generation and verification tools for projects based on the ISO 26262 standard. For more information,
see IEC Certification Kit.

Check for ISO 26262 Standard Compliance Using the Model Advisor
If you have a Simulink Check product license, you can check that your Simulink model or subsystem
and the code that you generate from it complies with selected aspects of the ISO 26262 standard.

To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Standards for ISO 26262.
3 Run the ISO 26262 (Simulink Check) checks.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

Validate Traceability
Typically, applications that require certification require some level of traceability between
requirements, models, and corresponding code.

To... Use...
Associate requirements documents with
objects in Simulink models

The “Requirements Management Interface Setup”
(Simulink Requirements) that is available if you have a
Simulink Requirements license.

Trace model blocks and subsystems to
generated code

The “Model-to-Code Traceability” on page 77-10
option when generating an HTML report during the
code generation or build process.

Trace generated code to model blocks and
subsystems

The “Code-to-Model Traceability” on page 77-8
option when generating an HTML report during the
code generation or build process.
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EN 50128 Standard

In this section...
“Apply Simulink and Embedded Coder to the EN 50128 Standard” on page 23-13
“Check for EN 50128 Standard Compliance Using the Model Advisor” on page 23-13
“Validate Traceability” on page 23-13

Apply Simulink and Embedded Coder to the EN 50128 Standard
Applying Model-Based Design to a safety-critical system requires extra consideration and rigor so
that the system adheres to defined safety standards. EN 50128, Railway applications - Software for
railway control and protection systems, is such a standard.

MathWorks provides an IEC Certification Kit product that you can use to certify MathWorks code
generation and verification tools for projects based on the EN 50128 standard. For more information,
see IEC Certification Kit.

Check for EN 50128 Standard Compliance Using the Model Advisor
If you have a Simulink Check product license, you can check that your Simulink model or subsystem
and the code that you generate from it complies with selected aspects of the EN 50128 standard.

To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Standards for EN 50128.
3 Run the EN 50128 (Simulink Check) checks.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

Validate Traceability
Typically, applications that require certification require some level of traceability between
requirements, models, and corresponding code.

To... Use...
Associate requirements documents with
objects in Simulink models

The “Requirements Management Interface Setup”
(Simulink Requirements) that is available if you have a
Simulink Requirements license.

Trace model blocks and subsystems to
generated code

The “Model-to-Code Traceability” on page 77-10
option when generating an HTML report during the
code generation or build process.

Trace generated code to model blocks and
subsystems

The “Code-to-Model Traceability” on page 77-8
option when generating an HTML report during the
code generation or build process.
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ISO 25119 Standard
In this section...
“Apply Simulink and Embedded Coder to the ISO 25119 Standard” on page 23-14
“Validate Traceability” on page 23-14

Apply Simulink and Embedded Coder to the ISO 25119 Standard
Applying Model-Based Design to a safety-critical system requires extra consideration and rigor so
that the system adheres to defined functional safety standards. ISO 25119, Tractors and machinery
for agriculture and forestry — Safety-related parts of control systems, is such a standard.

MathWorks provides an IEC Certification Kit product that you can use to qualify MathWorks code
generation and verification tools for projects based on the ISO 25119 standard. For more information,
see IEC Certification Kit.

Validate Traceability
Typically, applications that require certification require some level of traceability between
requirements, models, and corresponding code.

To... Use...
Associate requirements documents with
objects in Simulink models

The “Requirements Management Interface Setup”
(Simulink Requirements) that is available if you have a
Simulink Requirements license.

Trace model blocks and subsystems to
generated code

The “Model-to-Code Traceability” on page 77-10
option when generating an HTML report during the
code generation or build process.

Trace generated code to model blocks and
subsystems

The “Code-to-Model Traceability” on page 77-8
option when generating an HTML report during the
code generation or build process.
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DO-178C Standard

In this section...
“Apply Simulink and Embedded Coder to the DO-178C Standard” on page 23-15
“Check for Standard Compliance Using the Model Advisor” on page 23-15
“Validate Traceability” on page 23-15

Apply Simulink and Embedded Coder to the DO-178C Standard
Applying Model-Based Design to a high-integrity system requires extra consideration and rigor so
that the system adheres to defined safety standards. DO-178C, Software Considerations in Airborne
Systems and Equipment Certification, is such a standard. A supplement to DO-178C, DO-331,
provides guidance on the use of Model-Based Design technologies. MathWorks provides a DO
Qualification Kit product that you can use to qualify MathWorks verification tools for projects based
on the DO-178C, DO-331, and related standards. For more information, see https://
www.mathworks.com/products/do-178/.

For information about Model-Based Design and MathWorks support of aerospace and defense
industry standards, see DO Qualification Kit .

Check for Standard Compliance Using the Model Advisor
If you have a Simulink Check product license, you can check that your Simulink model or subsystem
and the code that you generate from it complies with selected aspects of the DO-178C standard.

To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Task > Modeling Standards for DO-178C/DO-331.
3 Run the DO-178C/DO-331 checks (Simulink Check) checks.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

Validate Traceability
Typically, applications that require certification require some level of traceability between
requirements, models, and corresponding code.

To... Use...
Associate requirements documents with
objects in Simulink models

The “Requirements Management Interface Setup”
(Simulink Requirements) that is available if you have a
Simulink Requirements license.

Trace model blocks and subsystems to
generated code

The “Model-to-Code Traceability” on page 77-10
option when generating an HTML report during the
code generation or build process.
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To... Use...
Trace generated code to model blocks and
subsystems

The “Code-to-Model Traceability” on page 77-8
option when generating an HTML report during the
code generation or build process.
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AUTOSAR Standard
Simulink software supports AUTomotive Open System ARchitecture (AUTOSAR), an open and
standardized automotive software architecture. Automobile manufacturers, suppliers, and tool
developers jointly develop AUTOSAR components.

The AUTOSAR standard addresses:

• Architecture – Application, run-time environment, and service layers, which serve to decouple
AUTOSAR software components from the execution platform. Standard interfaces between
software components and the run-time environment allow reuse or relocation of components
within the Electronic Control Unit (ECU) topology of a vehicle.

The standard defines two AUTOSAR platforms:

• Classic Platform (CP), with Application, Runtime Environment (RTE), and Basic Software
(BSW) layers

• Adaptive Platform (AP), with Application, AUTOSAR Runtime for Adaptive Applications (ARA),
Services, and Basis layers

• Methodology – Specification of code formats and description file templates, for example.
• Foundation – Requirements and specifications shared between AUTOSAR platforms, supporting

platform interoperability.
• Application Interfaces – Specification of interfaces for typical automotive applications.

For more information, see:

• www.autosar.org for details on the AUTOSAR standard.
• “AUTOSAR Blockset” for information on modeling and simulating AUTOSAR software, from which

Embedded Coder can generate code.
• “AUTOSAR Code Generation” for information about generating AUTOSAR-compliant C/C++ code

and XML software descriptions (requires AUTOSAR Blockset).
• MATLAB and Simulink for AUTOSAR to learn about using MathWorks products and third-party

tools for AUTOSAR.

Check for AUTOSAR Standard Compliance Using the Model Advisor
If you have an AUTOSAR Blockset product license, you can check that your Simulink model or
subsystem and the code that you generate from it complies with selected aspects of the AUTOSAR
standard.

To check your model or subsystem:

1 Open the Model Advisor.
2 Navigate to By Product > AUTOSAR Blockset.
3 Run the AUTOSAR (AUTOSAR Blockset) checks.

For more information on using the Model Advisor, see “Check Your Model Using the Model Advisor”.

 AUTOSAR Standard
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Develop a Model that Complies with the AUTOSAR Standard
Generate AUTOSAR-compliant C code and export AUTOSAR XML (ARXML) descriptions from a
Simulink® model.

AUTOSAR Blockset software supports AUTomotive Open System ARchitecture (AUTOSAR), an open
and standardized automotive software architecture. Automobile manufacturers, suppliers, and tool
developers jointly develop AUTOSAR components. To develop AUTOSAR components in Simulink,
follow this general workflow:

1 Create a Simulink representation of an AUTOSAR component.
2 Develop the component by refining the AUTOSAR configuration and creating algorithmic model

content.
3 Generate ARXML descriptions and algorithmic C code for testing in Simulink or integration into

an AUTOSAR run-time environment. (AUTOSAR code generation requires Simulink Coder and
Embedded Coder.)

Prepare Model for AUTOSAR Code Generation

To see the steps for generating AUTOSAR-compliant C code and exporting ARXML descriptions from
an AUTOSAR model, open a model and prepare the model for AUTOSAR code generation.

Open a model from which you want to generate AUTOSAR code and descriptions. The model can be
unconfigured or only partially configured for code generation. This example uses AUTOSAR example
model autosar_swc.

open_system(fullfile(matlabroot,'examples','autosarblockset','main','autosar_swc'));
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To prepare the model for AUTOSAR code generation, use the Embedded Coder Quick Start. From the
Apps tab, open the AUTOSAR Component Designer app. On the AUTOSAR tab, click Quick Start.

Work through the quick-start procedure. In the Output window, select output option C code
compliant with AUTOSAR.

The quick-start software takes the following steps to configure an AUTOSAR software component
model:

1 Configures code generation settings for the model. If the AUTOSAR target is not already
selected, the software sets model configuration parameter System target file to autosar.tlc
and Generate XML for schema version to a default schema value.

2 If no AUTOSAR mapping exists, creates a mapped AUTOSAR software component for the model.
3 Performs a model build.

In the last window, when you click Finish, your model opens in the AUTOSAR code perspective.

 Develop a Model that Complies with the AUTOSAR Standard
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Develop Simulink Representation of AUTOSAR Software Component

After you create an AUTOSAR software component model in Simulink, use the Code Mappings editor
and the AUTOSAR Dictionary to further develop the AUTOSAR component. For more information, see
“AUTOSAR Component Configuration” (AUTOSAR Blockset).

In a tabbed table format, the Code Mappings editor displays Simulink model elements, such as entry-
point functions, inports, outports, and data transfers. Use the editor to map Simulink model elements
to AUTOSAR component elements from a Simulink model perspective. AUTOSAR component
elements are defined in the AUTOSAR standard, and include runnable entities, ports, and inter-
runnable variables (IRVs).

In the AUTOSAR code perspective view of your model, select the Inports tab of the Code Mappings
editor, and select a model inport. The attributes of the selected inport appear in the Property
Inspector panel. This example selects Simulink inport In1_1s, which is mapped to AUTOSAR port
ReceivePort and data element In1 with data access mode ImplicitReceive. In each Code
Mappings editor tab, you can select model elements and modify their AUTOSAR mapping and
attributes. Your modifications are reflected in the generated ARXML descriptions and C code.

If you are using AUTOSAR example model autosar_swc with this example, modify the
communication attributes for the mapped Simulink inport In1_1s. In the Property Inspector, change
the AliveTimeout attribute from 60 to 30, change HandleNeverReceived from false to true,
and change InitValue from 0 to 1.

To configure the AUTOSAR properties of the mapped AUTOSAR software component, open the
AUTOSAR Dictionary. In the Code Mappings editor, click the AUTOSAR Dictionary button, which is
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the leftmost button. The AUTOSAR Dictionary opens in the AUTOSAR view that corresponds to the
Simulink element that you last selected and mapped in the Code Mappings editor. If you selected and
mapped a Simulink inport, the dictionary opens in ReceiverPorts view and displays the AUTOSAR
port to which you mapped the inport.

In a tree format, the AUTOSAR Dictionary displays the mapped AUTOSAR component and its
elements, communication interfaces, computation methods, software address methods, and XML
options. Use the dictionary to configure AUTOSAR elements and properties from an AUTOSAR
component perspective.

In the ReceiverPorts view, select the AUTOSAR receiver port to which the Simulink inport was
mapped in the Code Mappings editor. If an AUTOSAR element has additional undisplayed attributes,
selecting the element displays them. In each AUTOSAR element view, you can add or rename
AUTOSAR elements and modify their displayed properties. Your modifications are reflected in the
generated ARXML descriptions and C code.

If you are using AUTOSAR example model autosar_swc with this example, rename the AUTOSAR
receiver port from ReceivePort to RequirePort. To initiate the edit, click in the Name value field.

Generate C Code and ARXML Descriptions

If you have Simulink Coder and Embedded Coder software, you can build the AUTOSAR model.
Building the AUTOSAR model generates AUTOSAR-compliant C code and exports ARXML
descriptions. In the model window, press Ctrl+B.

When the build completes, a code generation report opens. Examine the report. Verify that your Code
Mappings editor and AUTOSAR Dictionary changes are reflected in the C code and ARXML
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descriptions. For example, use the Find field to search for the name of the AUTOSAR receiver port
that you modified and renamed.

The generated C code encodes the AUTOSAR receiver port name in AUTOSAR run-time environment
API read calls.

The generated ARXML description of the AUTOSAR receiver port uses the modified port name and
the modified values for port communication attributes AliveTimeout, HandleNeverReceived, and
InitValue.
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Related Links

• “Code Generation” (AUTOSAR Blockset)
• “AUTOSAR Component Configuration” (AUTOSAR Blockset)
• “AUTOSAR Blockset”
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Develop a Model that Complies with the IEC 61508 Standard
This example shows how to use the Model Advisor to check that a model complies with the IEC 61508
safety standard.

The IEC 61508 Model Advisor checks identify issues with a model that impede deployment in safety-
related applications or limit traceability.

Understanding the Model

Model rtwdemo_iec61508 check whether the 1-norm distance between points (x1,x2) and
(y1,y2) is less than or equal to a given threshold thr. For two points (x1,x2) and (y1,y2), the 1-
norm distance is given as:

∑
i = 1

2
|xi− yi|

Open and review the model.

model='rtwdemo_iec61508';
open_system(model)

Run the IEC 61508 Modeling Standard Checks

To deploy the model in a safety-related software component that must comply with the IEC 61508
safety standard, check the model for issues that might impede deployment in such an environment or
limit traceability between the model and generated source code.

1 To open the Model Advisor, in the Simulink editor, click the Modeling tab and select Model
Advisor. A System Selector - Model Advisor dialog box opens. Select the model or system that
you want to review and click OK. Or enter modeladvisor('rtwdemo_IEC61508') at the
MATLAB command line.

2 In the left pane of the Model Advisor, expand By Task > Modeling Standards for IEC 61508.
If the By Task folder is not displayed in the Model Advisor window, open Settings >
Preferences and select Show By Task Folder.

3 Select the checks that you want to include in your model analysis.
4 Click on the folder that contains the checks and, on the right pane of the Model Advisor, select

Show report after run to automatically generate and display the report in HTML format.
5 Click Run Selected Checks to execute the analysis.

Review Check Results

The Model Advisor processes the IEC 61508 checks and displays the results.

1 After the analysis is complete, review the aggregate results in the right pane of the Model
Advisor. You can see the total number of checks that passed, failed, were flagged as warnings,
and did not execute.

2 To review the results for a specific check, in the By Task > Modeling Standards for IEC
61508 folder, select a check. For more information about the check and how to resolve reported
issues, click Help.

3 Address the reported issues and rerun the checks.
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4 To review the generated HTML report of the results, select the By Task > Modeling Standards
for IEC 61508 folder and click the link in the Report box.

5 Print the generated HTML report. You can use the report as evidence in the IEC 61508
compliance process.

6 If desired, click the Generate Code Using Embedded Coder button in the model to inspect the
generated code and the traceability report.

See Also

• For descriptions of the IEC 61508 checks, see “IEC 61508, IEC 62304, ISO 26262, ISO 25119, and
EN 50128/EN 50657 Checks” (Simulink Check) in the Simulink Check documentation.

• For more information on using Model Advisor, see “Run Model Advisor Checks and Review
Results” in the Simulink documentation.

• For more information on resolving issues, see “Address Model Check Results” in the Simulink
documentation.
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MISRA C:2012 Compliance and
Deviations for Code Generated by Using
Embedded Coder

• “Developing a MISRA C:2012 Compliance Statement” on page 24-2
• “Evaluate Your Generated Code for MISRA C:2012 Compliance” on page 24-4
• “MISRA C:2012 Compliance Information Summary Tables” on page 24-6
• “Modeling Guidelines for MISRA C:2012 Compliance” on page 24-18
• “Deviations Rationale for MISRA C:2012 Compliance” on page 24-25
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Developing a MISRA C:2012 Compliance Statement
As part of the model development process, it is important that C code generated by Embedded Coder
from Simulink and Stateflow complies with industry coding standards.

When using MISRA C:2012 coding guidelines to evaluate the quality of your generated C code, you
are required per section 5.3 of the MISRA C:2012 Guidelines for the Use of C Language in Critical
Systems document to prepare a compliance statement for the project being evaluated. To assist you
in the development of this compliance statement, MathWorks evaluates the MISRA C:2012 guidelines
against C code generated by using Embedded Coder and provides the following information:

• Compliance Summary Tables on page 24-6, which identify the method used to obtain
compliance for each rule and directive.

• Deviations on page 24-25, which identify rules or directives that are not compliant.

For information about the process MathWorks uses to evaluate generated C code against MISRA
C:2012 guidelines, see “MathWorks Process for Identifying Violations of MISRA C:2012 Guidelines in
Generated C Code” on page 24-2.

For additional information about the MISRA organization, their coding guidelines, and the MISRA
publication timeline, see www.misra.org.uk .

Disclaimer While adhering to the recommendations in the MISRA C:2012 Compliance and
Deviations for Code Generated using Embedded Coder documentation will reduce the risk that an
error is introduced during development and not be detected, it is not a guarantee that the system
being developed will be safe. Conversely, if some of the recommendations are not followed, it does not
mean that the system being developed will be unsafe.

MathWorks Process for Identifying Violations of MISRA C:2012
Guidelines in Generated C Code
To determine any potential violations in the generated code, MathWorks maintains an extensive set of
test models that cover the standard usage of compliant blocks. For each release, MathWorks uses
these test models with the following products to evaluate the modeling, code generation, and analysis
of generated code.

Product Purpose
Simulink Create/maintain models.
Stateflow Create/maintain models.
Fixed-Point Designer Create/maintain models.
Embedded Coder Generate C code.
Simulink Check Execute MISRA C:2012 Model Advisor checks.a
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Product Purpose
Polyspace Bug Finder Identify bug/coding defects.

Use the Polyspace Bug Finder MISRA C:2012
Checker (Polyspace Bug Finder) to analyze the
generated code against the MISRA C:2012
Directives and Rules (Polyspace Bug Finder) and
provide information about violations.

Polyspace Code Prover Prove absence of run-time errors.

Use the Polyspace Code Prover MISRA C:2012
checker (Polyspace Code Prover) to analyze the
generated code against the MISRA C:2012
Directives and Rules (Polyspace Code Prover) and
provide information about violations.

a. MISRA C:2012 checks are available only when you have a Simulink Check or Embedded Coder license.

Note The compliance analysis performed by the Polyspace MISRA C:2012 Checker assesses C code
generated by Embedded Coder. No assessment is made of the Embedded Coder tool chain.
Handwritten C code and third-party libraries that are used with code generated by Embedded Coder
are not considered. Other MISRA C code analysis tools can yield different results.
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Evaluate Your Generated Code for MISRA C:2012 Compliance
It is important to check that C code generated by Embedded Coder from Simulink and Stateflow
complies with MISRA C:2012 coding standards. This workflow illustrates the process of evaluating
your generated code for compliance to MISRA C:2012 guidelines.

1 Design your model in Simulink or Stateflow.
2 Open the Model Advisor and run the MISRA C:2012 checks (Simulink Check), which are available

in By Task > Modeling Standards for MISRA C:2012.
3 If necessary, modify the model to adhere to the “Modeling Guidelines for MISRA C:2012

Compliance” on page 24-18.
4 After the MISRA C:2012 checks pass, generate code by using Embedded Coder.

To avoid possible name clashes, multiple functions definitions, and multiple data definitions, use
one of these code generation approaches:

• Single model: Generate code from a single model, including submodels, by using Model
blocks.

• Multiple models: Generate code from multiple models, including:

• A shared utility folder to synchronize functions
• Data ownership to control data definitions
• Hand integration to manage code generated from various models

5 Execute the Polyspace Bug Finder MISRA C:2012 Checker (Polyspace Bug Finder).

For more information about running a Polyspace analysis on your generated code, including
analysis options and results, see:

• “Polyspace Analysis in Simulink” (Polyspace Bug Finder)
• “Polyspace Analysis in Simulink” (Polyspace Code Prover)

6 Justify violations to the MISRA C:2012 coding standards using Polyspace annotations (Polyspace
Bug Finder).
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MISRA C:2012 Compliance Information Summary Tables
In this section...
“Compliance Summary Tables” on page 24-6
“Explanatory Notes” on page 24-15

Compliance Summary Tables
MathWorks evaluates C code generated by Embedded Coder from Simulink and Stateflow against the
MISRA C:2012 coding standards. The results from this effort are available in these compliance
summary tables. These tables identify:

• Methods used to obtain compliance:

• Compliant: Compliance to the rule/directive is achieved through adherence to the code
generation process, modeling guidelines, or Model Advisor checks. When applicable, there are
explanatory notes that provide information relevant to compliance methods or actions that you
can perform to satisfy the directive or rule.

• Deviation: The rule or directive is not compliant.
• Whether the Polyspace MISRA C:2012 Checker supports the rule or directive.

You can use these tables when preparing the MISRA C:2012 compliance statement for your project as
required per section 5.3 of the MISRA C:2012 Guidelines for the Use of C Language in Critical
Systems document. These tables align with the published MISRA C:2012 rule and directives tables.
These are based on Mandatory and Required categories only (not for Advisory and Readability
categories).

"Implementation" MISRA C:2012 Directives

Directive Category Compliance Polyspace
Support?

1.1 Required Compliant:

• hisl_0060
• hisl_0016
• “Explanatory Note for Directive 1.1” on page 24-15

Yes, partially
supported

"Compilation and Build" MISRA C:2012 Directives

Directive Category Compliance Polyspace
Support?

2.1 Required Compliant Yes
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"Requirements Traceability" MISRA C:2012 Directives

Directive Category Compliance Polyspace
Support?

3.1 Required Compliant:

• “Explanatory Note for MISRA Directive 3.1” on page
24-16

No
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"Code Design" MISRA C:2012 Directives

Directive Category Compliance Polyspace
Support?

4.1 Required Compliant:

• hisl_0001
• hisl_0002
• hisl_0003
• hisl_0004
• hisl_0005
• hisl_0006
• hisl_0007
• hisl_0008
• hisl_0010
• hisl_0011
• hisl_0028
• hisl_0053
• hisl_0054
• hisl_0067
• “Explanatory Note for Directive 4.1” on page 24-16

Yes

4.3 Required Compliant:

• “Explanatory Note for Directive 4.3” on page 24-16

No

4.6 Required Not Applicable.

• See “Explanatory Note for Directive 4.6” on page 24-
17

N/A

4.7 Required Compliant:

• Check for missing error ports for AUTOSAR receiver
interfaces

• Check for blocks not recommended for MISRA C:2012

Deviation:

• Deviation for AUTOSAR target-based code generator -
sender ports. See “MISRA C:2012 Directive 4.7
Deviation Rationale” on page 24-25

Yesa

4.10 Required Compliant Yes
4.11 Required Compliant:

• “Explanatory Note for Directive 4.11” on page 24-17

Yes
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Directive Category Compliance Polyspace
Support?

4.12 Required Compliant:

• hisl_0060

No

a. The Polyspace MISRA C:2012 Checker might flag Directive 4.7 as a Rule 17.7 violation (Polyspace Bug Finder) for user-
defined functions when there is no knowledge about whether the return value contains error information.

"Standard C Environment" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

1.1 Required Compliant Yes
1.3 Required Compliant Yes

"Unused Code" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

2.1 Required Compliant:

• hisl_0053
• hisl_0101
• hisl_0060
• “Explanatory Note for Rule 2.1” on page 24-17

Yes

2.2 Required Compliant Yes

"Comments" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

3.1 Required Compliant:

• Check for unsupported block names

Yes

3.2 Required Compliant Yes

"Character Sets and Lexical Conventions" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

4.1 Required Compliant Yes
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"Identifiers" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

5.1 Required Compliant:

• hisl_0060
• hisl_0063
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes

5.2 Required Compliant:

• hisl_0060
• hisl_0063
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes

5.4 Required Compliant:

• hisl_0060
• hisl_0063
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes

5.5 Required Compliant:

• hisl_0060
• hisl_0063
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes

5.6 Required Compliant:

• hisl_0060
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes

5.7 Required Compliant:

• hisl_0060
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes

5.8 Required Compliant:

• hisl_0060
• “Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7,

and 5.8” on page 24-17

Yes
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"Types" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

6.1 Required Compliant:

• hisl_0060

Yes

6.2 Required Compliant:

• hisl_0060

Yes

"Literals and Constants" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

7.1 Required Compliant Yes
7.2 Required Compliant Yes
7.4 Required Compliant Yes

"Declarations and Definitions" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

8.1 Required Compliant Yes
8.2 Required Compliant Yes
8.3 Required Compliant Yes
8.6 Required Compliant Yes
8.8 Required Compliant Yes
8.10 Required Compliant Yes
8.12 Required Compliant:

• “Explanatory Note for Rule 8.12” on page 24-17

Yes

8.14 Required Compliant Yes

"Initialization" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

9.1 Mandatory Compliant:

• hisl_0029
• Check usage of Assignment blocks

Yes

9.4 Required Compliant Yes
9.5 Required Compliant Yes

 MISRA C:2012 Compliance Information Summary Tables

24-11



"The Essential Type Model" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

10.2 Required Compliant Yes

"Pointer Type Conversion" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

11.1 Required Compliant Yes
11.2 Required Compliant Yes
11.3 Required Compliant:

• hisl_0020

Yes

11.6 Required Compliant Yes
11.7 Required Compliant Yes
11.8 Required Compliant:

• hisl_0020

Yes

"Expressions" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

12.2 Required Compliant Yes

"Side Effects" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

13.1 Required Compliant Yes
13.2 Required Compliant:

• hisl_0062

Yes

13.5 Required Compliant:

• hisl_0062

Deviation:

• “MISRA C:2012 Rule 13.5 Deviation Rationale” on
page 24-28

Yes

13.6 Mandatory Compliant Yes
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"Control Statement Expressions" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

14.2 Required Compliant:

• hisl_0006
• hisl_0007
• hisl_0008
• hisl_0010
• hisl_0011
• hisl_0101

Yes

14.3 Required Compliant:

• hisl_0101
• hisl_0060

Yes

"Control Flow" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

15.2 Required Compliant Yes
15.3 Required Compliant Yes
15.6 Required Compliant Yes
15.7 Required Compliant Yes

"Switch statements" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

16.2 Required Compliant Yes
16.3 Required Compliant Yes
16.4 Required Compliant:

• hisl_0006
• hisl_0007
• hisl_0008
• hisl_0010
• hisl_0011

Yes

16.5 Required Compliant Yes
16.6 Required Compliant Yes
16.7 Required Compliant Yes
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"Functions" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

17.1 Required Compliant Yes
17.2 Required Compliant:

• hisl_0060
• hisf_0004

Yes

17.3 Mandatory Compliant Yes
17.4 Mandatory Compliant Yes
17.6 Mandatory Compliant Yes

"Pointers and Arrays" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

18.1 Required Compliant Yes
18.2 Required Compliant Yes
18.3 Required Compliant Yes
18.6 Required Compliant Yes
18.7 Required Compliant Yes
18.8 Required Compliant Yes

"Overlapping Storage" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

19.1 Mandatory Compliant Yes

"Preprocessing Directives" MISRA C:2012 Rules

Rule Category Compliance Polyspace
Support?

20.2 Required Compliant Yes
20.3 Required Compliant Yes
20.4 Required Compliant Yes
20.6 Required Compliant Yes
20.7 Required Compliant Yes
20.9 Required Compliant Yes
20.11 Required Compliant Yes
20.12 Required Compliant Yes
20.13 Required Compliant Yes
20.14 Required Compliant Yes
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"Standard Libraries" MISRA C:2012 Rules
Rule Category Compliance Polyspace

Support?
21.1 Required Compliant Yes
21.2 Required Compliant:

• hisl_0032

Yes

21.3 Required Compliant:

• hisl_0060

Yes

21.4 Required Compliant Yes
21.5 Required Compliant Yes
21.6 Required Compliant:

• hisl_0060
• Check for blocks not recommended for MISRA C:2012

Yes

21.7 Required Compliant Yes
21.8 Required Compliant Yes
21.9 Required Compliant Yes
21.10 Required Compliant Yes
21.11 Required Compliant Yes
21.12 Required Compliant Yes

"Resources" MISRA C:2012 Rules
Rule Category Compliance Polyspace

Support?
22.1 Required Compliant Yes
22.2 Mandatory Compliant Yes
22.3 Required Compliant Yes
22.4 Mandatory Compliant Yes
22.5 Mandatory Compliant Yes
22.6 Mandatory Compliant Yes

Explanatory Notes
These explanatory notes are referenced from the “MISRA C:2012 Compliance Information Summary
Tables” on page 24-6.

Explanatory Note for Directive 1.1

Information about the implementation-defined behavior for Embedded Coder is available in
“Configure Run-Time Environment Options” on page 9-2 . Compiler documentation is out of scope.

Character set encoding is managed by using the SavedCharacterEncoding model parameter. For
additional information, see slCharacterEncoding.
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Configure the integer division method in the Model Configuration Parameters dialog box, on the
Hardware Implementation pane. For additional information, see “Configure Run-Time Environment
Options” on page 9-2

Embedded Coder generates #pragma when the user:

• Selects the use of memory sections
• Creates a custom storage class with memory sections on page 38-15

In both instances, you are responsible for documenting the intended use of the #pragma. For more
information, see “Control Data and Function Placement in Memory by Inserting Pragmas” on page
43-2.

To enable the generation of bitfields:

1 Select at least one of these model configuration parameters:

• Pack Boolean data into bitfields. This parameter is available only for ERT-based system
target files on page 48-2.

• Use bitsets for storing state configuration.
• Use bitsets for storing Boolean data.

2 Create a custom storage class with defined bitfields. See “Create Storage Classes by Using the
Custom Storage Class Designer” on page 38-15 for more information.

If your model uses conversion of one datatype to another, Polyspace Checker shows violation of Dir
1.1 from the generated code of the model. In this case, the violation coming from the model is not an
issue if you document this explicit conversion according to the MISRA guidelines.

Explanatory Note for MISRA Directive 3.1

You can link requirements model elements. These links are included in the generated C code to
provide traceability from a requirements document, to the model elements, and to the generated
code. For additional information, see “View Simulink Requirements Links Associated with Model
Elements” and “Link Blocks and Requirements” (Simulink Requirements).

Explanatory Note for Directive 4.1

You can use Polyspace Bug Finder to identify run-time errors and Polyspace Code Prover to prove the
absence of run-time errors. For information, see:

• “Configure and Run Analysis” (Polyspace Code Prover)
• “Configure and Run Analysis” (Polyspace Bug Finder)

Simulink Design Verifier can be used to detect design errors at the model level. For more information,
see “Run a Design Error Detection Analysis” (Simulink Design Verifier).

Explanatory Note for Directive 4.3

Embedded Coder does not directly call assembly language code. You can add calls to assembly
language functions through S-functions, code replacement libraries, Stateflow, and in MATLAB
blocks. These calls are documented as calls to “External C Functions” on page 25-48. In these cases,
you are responsible for encapsulation.

For additional information, see:
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• “External C Functions” on page 25-48
• “Code Replacement Customization”
• “Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2

Explanatory Note for Directive 4.6

Embedded Coder replaces basic data types with typedefs types, which are compatible with Directive
4.6. A guideline is not required because this behavior is default behavior in Embedded Coder. For
additional information, see “Replace and Rename Data Types to Conform to Coding Standards” on
page 36-22 and Typedefs on page 25-57.

Explanatory Note for Directive 4.11

The requirements of this directive are satisfied by:

“Demonstrate statically that the input parameters can never take invalid values”.

You can use Polyspace Code Prover to analyze parameter ranges and prove the absence of run-time
errors caused by out-of-range values. For additional information, see “Run Polyspace Analysis on
Code Generated with Embedded Coder” (Polyspace Code Prover).

Explanatory Note for Rule 2.1

Embedded Coder does not check user defined code from the Stateflow. You must take care of the
violations reported.

Explanatory Note for Rules 5.1, 5.2, 5.4, 5.5, 5.6, 5.7, and 5.8

Embedded Coder is configurable to limit the number of characters imposed by the implementation.
For additional information, see Maximum identifier length.

To ensure unique names for different types of variables (local scope variables, global scope variables,
macros, and so on), implement a naming convention. For additional information, see Model
Configuration Parameters: Code Generation Symbols.

Explanatory Note for Rule 8.12

Embedded Coder supports the use of enumerated data. The file used to define the enumeration can
be either manually or automatically generated. Files defining enumerations generated by Embedded
Coder are compliant with MISRA C:2012 Rule 8.12 by design. If you manually create the definition
file, you are responsible for ensuring compliance. For additional information, see “Use Enumerated
Data in Simulink Models”.

Explanatory Note for Rules 10.1 and 10.2

Embedded Coder does not directly create data of type char. Data of char type can be introduced by
user-defined S-functions, code replacement libraries, and custom storage classes. In this case, limit
the usage of plain char to:

• Plain char type for character values
• Signed and unsigned char type for numeric values
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Modeling Guidelines for MISRA C:2012 Compliance
The “MISRA C:2012 Compliance Information Summary Tables” on page 24-6 identifies modeling
guidelines that are relevant to the compliance of generated C code with MISRA C:2012 coding
standards. For a list of these guidelines and their corresponding Model Advisor check, see “High-
Integrity System Modeling Guidelines for MISRA C:2012 Compliance” on page 24-18. For
information about the MISRA rationale for Model Advisor checks, see “MISRA C:2012 Rationale for
Model Advisor Checks” on page 24-20.

High-Integrity System Modeling Guidelines for MISRA C:2012
Compliance
To augment the modeling guidelines developed by the MathWorks Advisory Board (MAB), MathWorks
has published a set of modeling guidelines that focus on high-integrity applications.

Many high-integrity modeling guidelines have Model Advisor checks that you can use to verify
adherence of your model to the guideline. This table identifies the high-integrity modeling guidelines
and provides the corresponding Model Advisor check. Not all modeling guidelines have a
corresponding Model Advisor check.

High-Integrity Guideline Model Advisor Check
“hisl_0001: Usage of Abs block” “Check usage of Abs blocks” (Simulink

Check)
“hisl_0002: Usage of Math Function blocks (rem and
reciprocal)”

“Check usage of Math Function blocks
(rem and reciprocal functions)”
(Simulink Check)

“hisl_0005: Usage of Product blocks” Not applicable
“hisl_0006: Usage of While Iterator blocks” “Check usage of While Iterator blocks”

(Simulink Check)
“hisl_0008: Usage of For Iterator Blocks” “Check usage of For Iterator blocks”

(Simulink Check)
“hisl_0010: Usage of If blocks and If Action Subsystem
blocks”

“Check usage of If blocks and If Action
Subsystem blocks” (Simulink Check)

“hisl_0011: Usage of Switch Case blocks and Action
Subsystem blocks”

“Check usage of Switch Case blocks
and Switch Case Action Subsystem
blocks” (Simulink Check)

“hisl_0016: Usage of blocks that compute relational
operators”

“Check for Relational Operator blocks
that equate floating-point types”
(Simulink Check)

“hisl_0017: Usage of blocks that compute relational
operators (2)”

“Check usage of Relational Operator
blocks” (Simulink Check)

“hisl_0018: Usage of Logical Operator block” “Check usage of Logical Operator
blocks” (Simulink Check)

“hisl_0019: Usage of bitwise operations” “Check usage of bit operation blocks”
(Simulink Check)
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High-Integrity Guideline Model Advisor Check
“hisl_0020: Blocks not recommended for MISRA C:2012
compliance”

“Check for blocks not recommended for
C/C++ production code deployment”
(Simulink Check)

“Check for blocks not recommended for
MISRA C:2012” (Simulink Check)

“hisl_0029: Usage of Assignment blocks” “Check usage of Assignment blocks”
(Simulink Check)

“hisl_0032: Model object names” “Check model object names” (Simulink
Check)

“hisl_0045: Configuration Parameters > Math and Data
Types > Implement logic signals as Boolean data (vs.
double)”

“Check safety-related optimization
settings for logic signals” (Simulink
Check)

“hisl_0053: Configuration Parameters > Code Generation >
Optimization > Remove code from floating-point to integer
conversions that wraps out-of-range values”

“Check safety-related optimization
settings for data type conversions”
(Simulink Check)

“hisl_0054: Configuration Parameters > Code Generation >
Optimization > Remove code that protects against division
arithmetic exceptions”

“Check safety-related optimization
settings for division arithmetic
exceptions” (Simulink Check)

“hisl_0060: Configuration parameters that improve MISRA
C:2012 compliance”

“Check configuration parameters for
MISRA C:2012” (Simulink Check)

“hisl_0061: Unique identifiers for clarity” “Check Stateflow charts for uniquely
defined data objects” (Simulink Check)

“hisl_0062: Global variables in graphical functions” “Check global variables in graphical
functions” (Simulink Check)

“hisl_0063: Length of user-defined object names to improve
MISRA C:2012 compliance”

“Check for length of user-defined
object names” (Simulink Check)

“hisl_0101: Avoid invariant comparison operations to
improve MISRA C:2012 compliance”

Not applicable

“hisl_0102: Data type of loop control variables to improve
MISRA C:2012 compliance”

“Check data type of loop control
variables” (Simulink Check)

“hisl_0314: Configuration Parameters > Diagnostics > Data
Validity > Signals”

“Check safety-related diagnostic
settings for signal data” (Simulink
Check)

“hisf_0003: Usage of bitwise operations” “Check usage of bitwise operations in
Stateflow charts” (Simulink Check)

“hisf_0004: Protect against recursive function calls to
improve code compliance”

Not applicable

“hisf_0064: Shift operations for Stateflow data to improve
code compliance”

“Check usage of shift operations for
Stateflow data” (Simulink Check)

“hisf_0065: Type cast operations in Stateflow to improve
code compliance”

“Check assignment operations in
Stateflow Charts” (Simulink Check)

“hisf_0211: Protect against use of unary operators in
Stateflow Charts to improve code compliance”

“Check Stateflow charts for unary
operators” (Simulink Check)
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MISRA C:2012 Rationale for Model Advisor Checks
This table provides MISRA C:2012 rationale for the Model Advisor checks.

Model Advisor Check MISRA C:2012 Rule or Directive
“Check configuration parameters for MISRA C:2012” (Simulink Check)
 Set Use division for fixed-point

net slope computation to On or
Use division for reciprocals
of integers only.

MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type.

Set Inf or NaN block output to
warning or error.

MISRA C:2012 Directive 4.1: Run-time failures
shall be minimized

Set Model Verification block
enabling to Disable All.

General recommendation for embedded systems.

Set Undirected event broadcasts
to error.

MISRA C:2012 Rule 17.2: Functions shall not call
themselves, either directly or indirectly

Set configuration parameter Wrap
on overflow to warning or error.

MISRA C:2012 Directive 4.1: Run-time failures
shall be minimized

Set Production hardware signed
integer division rounds to to Zero
or Floor.

MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type.

Clear Shift right on a signed
integer as arithmetic shift .

MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type.

Set Compile-time recursion limit
for MATLAB functions to 0 .

MISRA C:2012 Rule 17.2: Functions shall not call
themselves, either directly or indirectly

Clear Dynamic memory allocation
in MATLAB functions.

MISRA C:2012 Directive 4.12: Dynamic memory
allocation shall not be used.

MISRA C:2012 Rule 21.3: The memory allocation
and deallocation functions of <stdlib.h> shall not
be used.

Clear Enable run-time recursion
for MATLAB functions.

MISRA C:2012 Rule 17.2: Functions shall not call
themselves, either directly or indirectly

Set Bitfield declarator type
specifier to uint_T.

MISRA C:2012 Rule 6.1: Bit-fields shall only be
declared with an appropriate type

MISRA C:2012 Rule 6.2: Single-bit named bit
fields shall not be of a signed type

Set Casting Modes to Standards
Compliant.

MISRA C:2012 Rules 10.x: The essential type
model

Set Code replacement library to
None or AUTOSAR 4.0

General recommendation for embedded systems.
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Model Advisor Check MISRA C:2012 Rule or Directive
Clear External mode. General recommendation for embedded systems.

MISRA C:2012 Directive 4.12 Dynamic memory
allocation shall not be used

MISRA C:2012 Rule 21.3 The memory allocation
and deallocation functions of <stdlib.h> shall not
be used

MISRA C:2012 Rule 21.6 The Standard Library
input/output functions shall not be used

Clear Generate shared constants. MISRA Rule 8.5: An external object or function
shall be declared once in one and only one file

Clear MAT-file logging General recommendation for embedded systems.
Set Maximum identifier length to
the implementation-dependent limit.
The default is 31.

MISRA C:2012 Rules 5.1-9: Identifiers

Set Parentheses level to Maximum
(Specify precedence with
parentheses).

MISRA C:2012 Rule 12.1: The precedence of
operators within expressions should be made
explicit

Select Preserve static keyword in
function declarations.

MISRA Rule 8.7: Functions and objects should not
be defined with external linkage if they are
referenced in only one translation unit

MISRA Rule 8.8: The static storage class specifier
shall be used in all declarations of objects and
functions that have internal linkage

Clear Replace multiplications by
powers of two with signed bitwise
shifts.

MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type

Set Shared code placement to
Shared location

Prerequisite of configuration parameter Generate
shared constants

Clear Support continuous time. General recommendation for embedded systems.
Clear Support non-finite numbers MISRA C:2012 Directive 4.1: Run-time failures

shall be minimized
Clear Support non-inlined S-
functions.

General recommendation for embedded systems.
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Model Advisor Check MISRA C:2012 Rule or Directive
Set System-generated identifiers
to Shortened.

MISRA C:2012 5.1: External identifiers shall be
distinct

MISRA C:2012 5.2: Identifiers declared in the
same scope and name space shall be distinct

MISRA C:2012 5.4: Macro identifiers shall be
distinct

MISRA C:2012 5.5: Identifiers shall be distinct
from macro names

Set System target file to an ERT-
based target.

General recommendation for embedded systems.

Clear Use dynamic memory
allocation for model initialization.

Select only when Code Interface
Packaging is set to Reusable
Function.

MISRA C:2012 Directive 4.12: Dynamic memory
allocation shall not be used.

MISRA C:2012 Rule 21.3: The memory allocation
and deallocation functions of <stdlib.h> shall not
be used.

EnableSignedLeftShifts – off MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type

“Check for blocks not recommended for C/C++
production code deployment”

General recommendation for embedded systems.

“Check for blocks not recommended for MISRA C:2012”
 Lookup Table blocks using cubic

spline interpolation or extrapolation
methods.

Specific blocks are:

• 1-D Lookup Table
• 2-D Lookup Table
• n-D Lookup Table

MISRA C:2012 Rule 11.3: A cast shall not be
performed between a pointer to object type and a
pointer to a different object type.

MISRA C:2012 Rule 11.5: A conversion should not
be performed from pointer to void into pointer to
object.

MISRA C:2012 Rule 11.8: A cast shall not remove
any const or volatile qualification from the type
pointed to by a pointer.

MISRA C:2012 Rule 11.9: The macro NULL shall
be the only permitted form of integer null pointer
constant.

MISRA C:2012 Rule 12.1: The precedence of
operators within expressions should be made
explicit.
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Model Advisor Check MISRA C:2012 Rule or Directive
Deprecated Lookup Table blocks.

Specific blocks are:

• Lookup Table
• Lookup Table (2-D)

MISRA C:2012 Rule 11.3: A cast shall not be
performed between a pointer to object type and a
pointer to a different object type.

MISRA C:2012 Rule 11.5: A conversion should not
be performed from pointer to void into pointer to
object.

MISRA C:2012 Rule 11.8: A cast shall not remove
any const or volatile qualification from the type
pointed to by a pointer.

MISRA C:2012 Rule 11.9: The macro NULL shall
be the only permitted form of integer null pointer
constant.

MISRA C:2012 Rule 12.1: The precedence of
operators within expressions should be made
explicit.

MISRA C:2012 Rule 12.2: The right hand operand
of a shift operator shall lie in the range zero to one
less than the width in bits of the essential type of
the left hand operand.

S-Function Builder blocks MISRA C:2012 Rule 8.4: A compatible declaration
shall be visible when an object or function with
external linkage is defined.

MISRA C:2012 Rule 8.5: An external object or
function shall be declared once in one and only
one file.

From Workspace blocks MISRA C:2012 Rule 18.4: The +, -, += and -=
operators should not be applied to an expression
of pointer type.

String blocks were found in the
model or subsystem.

Specific blocks are:

• Compose String
• Scan String
• String to Single
• String to Double
• To String

MISRA C:2012 Directive 4.7: If a function returns
error information, then that error information
shall be tested

MISRA C:2012 Rule 17.7: The value returned by a
function having non-void return type shall be used

MISRA C:2012 Rule 21.6: The Standard Library
input/output functions shall not be used

“Check for unsupported block names” (Simulink
Check)

MISRA C:2012 Rule 3.1: The character
sequences /* and // shall not be used within a
comment.
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Model Advisor Check MISRA C:2012 Rule or Directive
“Check usage of Assignment blocks” (Simulink
Check)

MISRA C:2012 Rule 9.1: The value of an object
with automatic storage duration shall not be read
before it has been set.

“Check for switch case expressions without a
default case” (Simulink Check)

MISRA C:2012 Rule 16.4: Every switch statement
shall have a default label.

“Check for missing error ports for AUTOSAR
receiver interfaces” (Simulink Check)

MISRA C:2012 Directive 4.7 If a function returns
error information, then that error information
shall be tested.

MISRA C:2012 Rule 17.7: The value returned by a
function having non-void return type shall be used.

“Check for bitwise operations on signed integers”
(Simulink Check)

MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type.

“Check for recursive function calls” (Simulink
Check)

MISRA C:2012 Rule 17.2: Functions shall not call
themselves, either directly or indirectly.

“Check for equality and inequality operations on
floating-point values” (Simulink Check)

MISRA C:2012 Directive 1.1: Any implementation-
defined behaviour on which the output of the
program depends shall be documented and
understood.

“Check for missing const qualifiers in model
functions” (Simulink Check)

MISRA C:2012 Rule 8.13: A pointer should point to
a const-qualified type whenever possible.

“Check integer word length” (Simulink Check) MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type.

“Check bus object names that are used as bus
element names” (Simulink Check)

MISRA C:2012 Rule 10.1: Operands shall not be of
an inappropriate essential type.

MISRA C:2012 Rule 5.6: A typedef name shall be a
unique identifier.
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Deviations Rationale for MISRA C:2012 Compliance
Instances in which the generated code does not comply with the MISRA C:2012 guidelines are
marked as deviations in the “MISRA C:2012 Compliance Information Summary Tables” on page 24-6.
In accordance with Section 5.4 of the MISRA C:2012 guidelines,information about the deviations
includes:

• The guideline being deviated
• The circumstances in which the deviation is permitted
• Justification for the deviation, including a risk assessment
• Demonstration of how safety is assured
• Potential consequences of non-conformance

Deviations to the MISRA C:2012 directives and rules include:

• “MISRA C:2012 Directive 4.7 Deviation Rationale” on page 24-25
• “MISRA C:2012 Rule 13.5 Deviation Rationale” on page 24-28

MISRA C:2012 Directive 4.7 Deviation Rationale
Directive Definition

If a function returns error information, then that error information shall be tested.

Rationale

Note This directive is violated only when an AUTOSAR-based code generation target is used.

When a function call provides information that indicates an unsuccessful operation, the calling
program has to check for the indication of an error when the function is returned. The function calls
are not limited to calls in the standard library.

Description

AUTOSAR sender interface function calls, such as Rte_Write_..., have return type
Std_ReturnType that indicates if writing the value was successful. The matching Simulink pattern
is a top-level output port that is configured as an AUTOSAR Sender Interface.

Model Example
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AUTOSAR Configuration
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Generated Code Sample

In the sample code, note the use of AUTOSAR function call Rte_Write_... in
Rte_Write_OUT_DE1_OUT_DE1(rtb_TmpSignalConversionAtIN_DE1);.

void Runnable_Step(void)
{
  /* local block i/o variables */
  real_T rtb_TmpSignalConversionAtIN_DE1;
  …
  rtb_TmpSignalConversionAtIN_D_l = Rte_Read_IN_DE1_IN_DE1
    (&rtb_TmpSignalConversionAtIN_DE1);
  …
  if (rtb_TmpSignalConversionAtIN_D_l > 0) {
    …
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    Rte_Write_OUT_DE1_OUT_DE1(rtb_TmpSignalConversionAtIN_DE1);
  }
  …
}

Justification

Failures of Rte_Write_... function calls are typically handled on the receiver side because function
call returns do not always include all potential errors.

Conditions Under Which the Deviation is Requested

The deviation is requested for all instances of AUTOSAR sender ports.

Consequences of Noncompliance

The calling program cannot react when the sender operation is unsuccessful.

Actions to Control Reporting

When a Polyspace analysis of your code finds known or acceptable coding rule violations, you can
suppress the violations in subsequent analyses by adding code annotations (Polyspace Bug Finder) to
the Outport block. In future analyses, Polyspace hides results justified through annotations in the
Results List pane. To review the coding rule violations, see “Filter and Group Results in Polyspace
Desktop User Interface” (Polyspace Bug Finder).

If you have already provided annotations for MISRA C:2004 violations, Polyspace imports these
justifications when you check your code for MISRA C:2012 violations. For additional information, see
“Import Existing MISRA C: 2004 Justifications to MISRA C: 2012 Results” (Polyspace Bug Finder).

For additional information, see:

• “Modeling Patterns for AUTOSAR Runnables” (AUTOSAR Blockset)
• “Develop a Model that Complies with the AUTOSAR Standard” on page 23-18
• “MISRA C:2012 Compliance Information Summary Tables” on page 24-6

MISRA C:2012 Rule 13.5 Deviation Rationale
Rule Definition

The right hand operand of a logical && or || operator shall not contain persistent side effects.

Rationale

Persistent side effects of the right hand side operand of the && and || operators can occur depending
on the left hand side operand, which is contrary to the expectations of the programmer.

Note The term persistent side effect is defined in "Appendix J: Glossary" of the MISRA C:2012
Guidelines for the Use of C Language in Critical Systems document.

Description
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Using math operations as second input to Logical Operator blocks configured as AND or OR
operation.

Model Example

Generated Code Sample

In the sample code, note the use of operand && in Y1 = (U1 && (sqrt(U2) <= 3.0));.

/* Exported block signals */
boolean_T U1;                /* '<Root>/U1' */
real_T U2;                   /* '<Root>/U2' */
boolean_T Y1;                /* '<Root>/Logical Operator' */

/* Model step function */
void DEV_R1305_01main_step(void)
{
  /* Logic: '<Root>/Logical Operator' incorporates:
   *  Constant: '<S1>/Constant'
   *  Inport: '<Root>/U1'
   *  Inport: '<Root>/U2'
   *  RelationalOperator: '<S1>/Compare'
   *  Sqrt: '<Root>/Sqrt'
   */
  Y1 = (U1 && (sqrt(U2) <= 3.0));
}

Justification

Some standard math functions have at least one persistent side effect of modifying the global errno
variable, as defined in the C90 or C99 standard. Since the errno variable is not used by Embedded
Coder, the second operand can be treated as not having persistent side effects.

Note Polyspace Bug Finder treats every function with no available source code as potentially having
side effects.

Conditions Under Which the Deviation is Requested
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This deviation is requested for all calls to standard math functions used as right hand side argument
of && and || operators.

Consequences of Noncompliance

There are no consequences associated with noncompliance with MISRA C:2012 Rule 13.5 in the
circumstances described in this deviation record. There are no additional verification and validation
requirements resulting from this deviation.

Actions to Control Reporting

When a Polyspace analysis of your code finds known or acceptable coding rule violations, you can
suppress the violations in subsequent analyses by adding code annotations (Polyspace Bug Finder) to
the Logical Operator block. In future analyses, Polyspace hides results justified through annotations
in the Results List pane. To review the coding rule violations, see “Filter and Group Results in
Polyspace Desktop User Interface” (Polyspace Bug Finder).

If you have already provided annotations for MISRA C:2004 violations, Polyspace imports these
justifications when you check your code for MISRA C:2012 violations. For additional information, see
“Import Existing MISRA C: 2004 Justifications to MISRA C: 2012 Results” (Polyspace Bug Finder).

For additional information, see “MISRA C:2012 Compliance Information Summary Tables” on page
24-6.
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Patterns for C Code in Embedded Coder

• “Prepare a Model for Code Generation” on page 25-2
• “Definition, Initialization, and Declaration of Parameter Data” on page 25-5
• “Definition and Declaration of Signal Data” on page 25-7
• “Data Type Conversion” on page 25-9
• “Type Qualifiers” on page 25-12
• “Relational and Logical Operators” on page 25-14
• “Bitwise Operations” on page 25-17
• “Enumeration” on page 25-20
• “If-Else” on page 25-23
• “Switch” on page 25-27
• “For Loop” on page 25-31
• “While Loop” on page 25-35
• “Do While Loop” on page 25-40
• “Function Call” on page 25-43
• “Function Prototyping” on page 25-45
• “External C Functions” on page 25-48
• “Macro Definitions (#define)” on page 25-54
• “Conditional Inclusions (#if / #endif)” on page 25-56
• “Typedef” on page 25-57
• “Structures of Parameters” on page 25-59
• “Structures of Signals” on page 25-62
• “Nested Structures of Signals” on page 25-64
• “Bitfields” on page 25-68
• “Arrays for Parameters” on page 25-70
• “Arrays for Signals” on page 25-71
• “Pointers” on page 25-73
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Prepare a Model for Code Generation
Several standard methods are available for setting up a model to generate specific C constructs in
your code. For preparing your model for code generation, some of these methods include: configuring
signals and ports, initializing states, and setting up configuration parameters for code generation.
Depending on the components of your model, some of these methods are optional. Methods for
configuring a model to generate specific C constructs are organized by category, for example, the
Control Flow category includes constructs if-else, switch, for, and while. Refer to the name of a
construct to see how you should configure blocks and parameters in your model. Different modeling
methodologies are available, such as Simulink blocks, Stateflow charts, and MATLAB Function blocks,
to implement a C construct.

Model examples in “Modeling Patterns for C Code” have the following naming conventions:

Model Components Naming Convention
Inputs u1, u2, u3, and so on
Outputs y1, y2, y3, and so on
Parameters p1, p2, p3, and so on
States x1, x2, x3, and so on

Input ports are named to reflect the signal names that they propagate.

Configure Input Ports, Output Ports, and Arbitrary Signals
1 Create a model in Simulink. For more information, see “Interactive Model Editing”.
2 On the Modeling tab, click Model Data Editor. You can also use the keyboard shortcut Ctrl +

Shift + E.
3 Set the Change view drop-down list to Design.
4 Use the Storage Class column to apply a storage class to the signal.

For example, apply the storage class ExportedGlobal, which makes the signal appear in the
generated code as a separate global variable. The variable has the same name as the signal in
the model.

Initialize and Configure States
1 In the Model Data Editor, on the States tab, use the Initial Value column to specify initial values

for a block state (such as the state of a Unit Delay block).
2 Set the Change view drop-down list to Code.
3 Use the Name column to give the state a name.
4 Use the Storage Class column to apply a storage class to the state.

Set Up Configuration Parameters for Code Generation
1 On the C Code tab, click Settings to open the Configuration Parameters dialog box. You can also

use the keyboard shortcut Ctrl + E.
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Open the Configuration Parameter dialog box by selecting Simulation > Model Configuration
parameters.

2 Open the Solver pane and select

• Solver type: Fixed-Step
• Solver: discrete (no continuous states)

3 Open the Optimization pane, and set Default parameter behavior to Inlined.
4 Open the Code Generation pane, and specify ert.tlc as the System Target File.
5 Clear Generate makefile.
6 Select Generate code only.
7 Enable the HTML report generation by opening the Code Generation > Report pane and

selecting Create code generation report and Open report automatically. Click the
horizontal ellipsis and, under Advanced parameters, select Code-to-model. Enabling the
HTML report generation is optional.

8 Click Apply and then OK to exit.

Set Up an Example Model With a Stateflow Chart

Follow this general procedure to create a simple model containing a Stateflow chart.

1 From the Stateflow > Chart library, add a Stateflow chart to your model .
2 Add Inport blocks and Outport blocks according to the example model.
3 Open the Stateflow Editor by performing one of the following:

• Double-click the Stateflow chart.
• Press Ctrl+R.

4 Add inputs to you chart as described in “Add Stateflow Data” (Stateflow).
5 Specify the Name (u1, u2, ...) and the Type (Inherit: Same as Simulink) for each

input, unless specified differently in the example.
6 Add outputs to you chart as described in “Add Stateflow Data” (Stateflow).
7 Specify the Name (y1, y2, ...) and Type (Inherit: Same as Simulink) for each output,

unless specified differently in the example.
8 In the Stateflow Editor, create the Stateflow diagram specific to the example.
9 The inputs and outputs appear on the chart in your model.
10 Connect the Inport and Outport blocks to the Stateflow Chart.
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11 Configure the input and output signals; see “Configure Input Ports, Output Ports, and Arbitrary
Signals” on page 25-2.

Set Up an Example Model With a MATLAB Function Block

1 Add the number of Inport and Outport blocks according to a C construct example included in this
chapter.

2 From the Simulink User-defined Functions library drag a MATLAB Function block into the model.
3 Double-click the block. The MATLAB Function Block Editor opens. Edit the function to implement

your application.
4 On the Editor tab, click Save and close the MATLAB Function Block Editor.
5 Connect the Inport and Outport blocks to the MATLAB Function block. See “Configure Input

Ports, Output Ports, and Arbitrary Signals” on page 25-2.
6 Save your model.
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Definition, Initialization, and Declaration of Parameter Data
This example shows how to export the definition, initialization, and declaration of a global variable
that the generated code uses as a parameter.

C Construct

int32 myParam = 3;

extern int32 myParam;

Procedure

1. Open the example model ex_defn_decl.

2. In the model, select the Gain block. In the Property Inspector, set the value of the Gain parameter
to myParam.

3. Next to the parameter value, click the action button (the button with three vertical dots) and select
Create.

4. In the Create New Data dialog box, set Value to Simulink.Parameter(3). Click Create. A
Simulink.Parameter object, myParam, appears in the base workspace. The Gain block uses the
object to set the value of the Gain parameter, in this case, 3.

5. In the Simulink.Parameter property dialog box, set Data type to int32.

6. Set Storage class to ExportToFile.

7. Set Header File to myDecls.h.

8. Set Definition File to myDefns.c. Click OK.

9. To build the model and generate code, press Ctrl+B .

Results

The generated header file myDecls.h declares the global variable myParam by using the extern
keyword.

/* Declaration for custom storage class: ExportToFile */
extern int32_T myParam;                /* Referenced by: '<Root>/Gain' */

The generated source file myDefns.c defines and initializes myParam.
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/* Definition for custom storage class: ExportToFile */
int32_T myParam = 3;                   /* Referenced by: '<Root>/Gain' */

See Also

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Control Placement of Global Data Definitions and Declarations in Generated Files” on page 35-

2
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Definition and Declaration of Signal Data
This example shows how to export the definition and declaration of a global variable that the
generated code uses as a signal.

C Construct

float mySig;

extern float mySig;

Procedure

1. Open the example model ex_defn_decl.

open_system('ex_defn_decl');

2. In the Model Data Editor, open the Inports/Outports tab.

3. In the Model Data Editor, for the Inport block, set Data Type to single.

set_param('ex_defn_decl/In1','OutDataTypeStr','single');

4. Open the Embedded Coder app.

5. In the C Code tab, select Code Interface > Individual Element Code Mappings.

6. In the Code Mappings editor, on the Inports tab, set Storage class for the Inport block to
ExportToFile.

7. In the Property Inspector, set Identifier to mySig, Header File to myDecls.h, and Definition
File to myDefns.c.

cm = coder.mapping.api.get('ex_defn_decl');
setInport(cm,'In1','StorageClass','ExportToFile','Identifier','mySig','HeaderFile','myDecls.h','DefinitionFile','myDefns.c');

8. Generate code from the model.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
evalc('slbuild(''ex_defn_decl'')');

Results

The generated header file myDecls.h declares the global variable mySig by using the extern
keyword.

file = fullfile('ex_defn_decl_ert_rtw','myDecls.h');
rtwdemodbtype(file,'/* Declaration for', ...
    'extern real32_T mySig',1,1);
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/* Declaration for custom storage class: ExportToFile */
extern real32_T mySig;                 /* '<Root>/In1' */

The generated source file myDefns.c defines and initializes mySig.

file = fullfile('ex_defn_decl_ert_rtw','myDefns.c');
rtwdemodbtype(file,'/* Definition for', ...
    'real32_T mySig;',1,1);

/* Definition for custom storage class: ExportToFile */
real32_T mySig;                        /* '<Root>/In1' */

See Also

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Configure Signal Data for C Code Generation” on page 33-51
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Data Type Conversion
This example shows how to create a data type conversion by using a Data Type Conversion block,
Stateflow Chart, or MATLAB Function block.

C Construct

y1 = (double)u1;

Modeling Pattern for Data Type Conversion — Simulink Block

To create a data type conversion, use a Data Type Conversion block from the Simulink > Commonly
Used Blocks library.

1. Open example model ex_data_type_SL.

2. Click the Inport block. In the Property Inspector, under Signal Attributes, specify Data type as
int32.

3. Click the Data Type Conversion block. In the Property Inspector, specify the Output data type
parameter as double.

4. In the Configuration Parameters dialog box, set the Casting modes parameter to Explicit. By
default, Simulink sets the Casting modes parameter to Nominal that generates minimal casting. For
more details, see “Control Cast Expressions in Generated Code” on page 53-38.

5. To build the model and generate code, press Ctrl+B .

The generated code appears in ex_data_type_SL.c:

int32_T u1;                            /* '<Root>/u1' */
real_T y1;                             /* '<Root>/y1' */

/* Model step function */
void ex_data_type_SL_step(void)
{
  /* Outport: '<Root>/y1' incorporates:
   *  DataTypeConversion: '<Root>/Data Type Conversion'
   *  Inport: '<Root>/u1'
   */
  y1 = (real_T)u1;
}

The code generator type definition for double is real_T.

Modeling Pattern for Data Type Conversion — Stateflow Chart

You can use a Stateflow® chart in place of a Data Type Conversion block, to create a data type
conversion.
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1. Open example model ex_data_type_SF.

2. Click the Inport block. In the Property Inspector, under Signal Attributes, specify Data type as
int32.

3. In the Configuration Parameters dialog box, set the Casting modes parameter to Explicit.

4. To build the model and generate code, press Ctrl+B .

The generated code appears in ex_data_type_SF.c:

int32_T u1;                            /* '<Root>/u1' */
real_T y1;                             /* '<Root>/Type_Conversion' */

/* Model step function */
void ex_data_type_SF_step(void)
{
  /* Chart: '<Root>/Type_Conversion' incorporates:
   *  Inport: '<Root>/u1'
   */
  y1 = (real_T)u1;
}

Modeling Pattern for Data Type Conversion — MATLAB Function Block

1. Open example model ex_data_type_ML.

2. The MATLAB Function Block contains this function:

function y1 = typeconv(u1)
y1 = double(u1); 
end

3. Click the Inport block. In the Property Inspector, under Signal Attributes, specify Data type as
int32.
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4. In the Configuration Parameters dialog box, set the Casting modes parameter to Explicit.

5. To build the model and generate code, press Ctrl+B .

The generated code appears in ex_data_type_ML.c:

int32_T u1;                            /* '<Root>/u1' */
real_T y1;                             /* '<Root>/MATLAB Function' */

/* Model step function */
void ex_data_type_ML_step(void)
{
  /* MATLAB Function: '<Root>/MATLAB Function' incorporates:
   *  Inport: '<Root>/u1'
   */
  y1 = (real_T)u1;
}

Other Type Conversions in Modeling

Type conversions can also occur on the output of blocks where the output variable is specified as a
different data type. For example, in the Gain block, you can set the Parameter data type as
Inherit via internal rule to control the output signal data type. Another example of type
conversion can occur at the boundary of a Stateflow chart. You can specify the output variable as a
different data type.

See Also
Data Type Conversion

Related Examples
• “Parameter Data Types in the Generated Code” on page 34-129
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Type Qualifiers
This example shows how to apply the const and volatile keywords to a global variable that
represents parameter data.

C Construct

const volatile double myParam = 9.8;

Procedure

1. Open the example model ex_const_volatile.

open_system('ex_const_volatile');

2. In the model, select the Gain block. In the Property Inspector, set the value of the Gain parameter
to myParam.

3. Next to the parameter value, click the action button (the button with three vertical dots) and select
Create.

myParam = Simulink.Parameter(9.8);
set_param('ex_const_volatile/Gain','Gain','myParam');

4. In the Create New Data dialog box, set Value to Simulink.Parameter(9.8). Click Create. A
Simulink.Parameter object, myParam, appears in the base workspace. The Gain block uses the
object to set the value of the Gain parameter, in this case, 9.8.

5. On the Code Generation tab, click the Configure in Coder App button. In the Code Mappings
editor, set Storage Class to ConstVolatile. Alternatively, to apply only one of the keywords, use
the storage classes Const or Volatile.

myParam.StorageClass = 'ConstVolatile';

6. To build the model and generate code, press Ctrl+B .

currentDir = pwd;
[~,cgDir] = rtwdemodir();
evalc('slbuild(''ex_const_volatile'')');

Results

The generated source file ex_const_volatile.c defines myParam by using the const and
volatile keywords.

file = fullfile('ex_const_volatile_ert_rtw','ex_const_volatile.c');
rtwdemodbtype(file,'/* Definition for custom', ...
    'const volatile real_T myParam = 9.8;',1,1);
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/* Definition for custom storage class: ConstVolatile */
const volatile real_T myParam = 9.8;   /* Referenced by: '<Root>/Gain' */

See Also

Related Examples
• “Create Tunable Calibration Parameter in the Generated Code” on page 34-109
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
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Relational and Logical Operators
This example shows how to implement relational and logical operators by using Simulink blocks,
Stateflow Charts, and MATLAB Function blocks.

Modeling Pattern for Relational or Logical Operators — Simulink Blocks

To include a logical operation in your model, use the Logical Operator block from the Logic and Bit
Operations library.

1. Open example model ex_data_type_SL.

The Logical Operator block performs an OR operation in the model. To change the operation, double-
click the block and set the Operator field to any of the operations in the menu.

You can implement relational operators by replacing the Logical Operator block with a Relational
Operator block.

2. To build the model and generate code, press Ctrl+B.

The code implementing the logical operator OR is in the ex_logical_SL_step function in
ex_logical_SL.c.

/* Exported block signals */
boolean_T u1;                          /* '<Root>/u1' */
boolean_T u2;                          /* '<Root>/u2' */
boolean_T y1;                          /* '<Root>/y1' */

/* Model step function */
void ex_logical_SL_step(void)
{
  /* Outport: '<Root>/y1' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   *  Logic: '<Root>/Logical Operator'
   */
  y1 = (u1 || u2);
}

Modeling Pattern for Relational and Logical Operators — Stateflow Chart

1. Open example model ex_data_type_SF.
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In the Stateflow chart, the relational or logical operation actions are on the transition from one
junction to another. Relational statements specify conditions to conditionally allow a transition. In
that case, the statements are within square brackets.

2. To build the model and generate code, press Ctrl+B.

The code implementing the logical operator OR is in the ex_logical_SF_step function in
ex_logical_SF.c.

/* Exported block signals */
boolean_T u1;                          /* '<Root>/u1' */
boolean_T u2;                          /* '<Root>/u2' */
boolean_T y1;                          /* '<Root>/Logical Operator' */

/* Model step function */
void ex_logical_SF_step(void)
{
  /* Chart: '<Root>/Logical Operator' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  y1 = (u1 || u2);
}

Modeling Pattern for Relational and Logical Operators — MATLAB Function Block

This example shows the MATLAB Function block method for incorporating operators into the
generated code by using a relational operator.

1. Open example model ex_logical_ML.

2. The MATLAB Function Block contains this function:

function y1 = fcn(u1, u2)
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y1 = u1 > u2; 
end

3. To build the model and generate code, press Ctrl+B.

The generated code appears in ex_data_type_ML.c:

/* Exported block signals */
real_T u1;                             /* '<Root>/u1' */
real_T u2;                             /* '<Root>/u2' */
boolean_T y;                           /* '<Root>/MATLAB Function' */

/* Model step function */
void ex_logical_ML_step(void)
{
  /* MATLAB Function: '<Root>/MATLAB Function' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  y = (u1 > u2);
}

See Also
Logical Operator
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Bitwise Operations
This example shows how to implement bitwise operations by using Simulink blocks, Stateflow Charts,
and MATLAB Function blocks.

Simulink Bitwise-Operator Block

To include a logical operation in your model, use the Bitwise Operator block from the Logic and Bit
Operations library.

1. Open example model ex_bit_logic_SL.

The Logical Operator blocks perform an AND operation in the model. To change the operation,
double-click the block and set the Operator field to any of the operations in the menu.

2. Double-click the block to open the Block Parameters dialog box.

3. To perform bitwise operations with a bit-mask, select Use bit mask.

If another input uses bitwise operations, clear the Use bit mask parameter and enter the number of
input ports.

4. In the Bit Mask field, enter a decimal number. Use bin2dec or hex2dec to convert the input from
binary or hexadecimal. In this example, enter hex2dec('D9').

5. To build the model and generate code, press Ctrl+B.

The code implementing the bitwise operator AND is in the ex_bit_logic_SL_step function in
ex_bit_logic_SL.c:

/* Exported block signals */
uint8_T u1;                            /* '<Root>/u1' */
uint8_T y1;                            /* '<Root>/Bitwise Operator' */

/* Model step function */
void ex_bit_logic_SL_step(void)
{
  /* S-Function (sfix_bitop): '<Root>/Bitwise Operator' incorporates:
   *  Inport: '<Root>/u1'
   */
  y1 = (uint8_T)(u1 & 217);
}

Stateflow Chart

1. Open example model ex_bit_logic_SF.
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2. Right-click the Stateflow chart to open the chart Properties.

3. Verify that the Enable C-bit operations check box is selected. For more information, see “Enable
C-bit operations” (Stateflow).

4. To build the model and generate code, press Ctrl+B.

The code implementing the bitwise operator AND is in the ex_bit_logic_SF_step function in
ex_bit_logic_SF.c:

/* Exported block signals */
uint8_T u1;                            /* '<Root>/u1' */
uint8_T y1;                            /* '<Root>/Bit_Logic' */

/* Model step function */
void ex_bit_logic_SF_step(void)
{
  /* Chart: '<Root>/Bit_Logic' incorporates:
   *  Inport: '<Root>/u1'
   */
  y1 = (uint8_T)(u1 & 0xD9);
}

MATLAB Function Block

In this example, to show the MATLAB Function block method for implementing bitwise logic into the
generated code, use the bitwise OR, '|'.

1. Open example model ex_bit_logic_ML.

2. The MATLAB Function Block contains this function:

function y1 = fcn(u1, u2)
%#eml
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y1 = bitor(u1, u2);
end

3. To build the model and generate code, press Ctrl+B.

The code implementing the bitwise operator OR is in the ex_bit_logic_ML_step function in
ex_bit_logic_ML.c:

/* Exported block signals */
uint8_T u1;                            /* '<Root>/u1' */
uint8_T u2;                            /* '<Root>/u2' */
uint8_T y1;                            /* '<Root>/Bitwise OR' */

/* Model step function */
void ex_bit_logic_ML_step(void)
{
  /* MATLAB Function: '<Root>/Bitwise OR' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  y1 = (uint8_T)(u1 | u2);
}

See Also
Bitwise Operator
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Enumeration
To generate an enumerated data type, define an enumeration class in a MATLAB file. Then, use the
enumeration class as the data type of signals, block parameters, and states in your model.

C Construct

typedef enum {
  Choice1 = 0,
  Choice2
} myEnumType;

Procedure

In your current folder, create the MATLAB file ex_myEnumType.m. The file defines an enumeration
class ex_myEnumType.

classdef ex_myEnumType < Simulink.IntEnumType
    
    enumeration
        Choice1(0)
        Choice2(1)
    end %enumeration
    
    methods (Static)
        function retVal = getHeaderFile()
            retVal = 'myEnumHdr.h';
        end %function
        
        function retVal = getDataScope()
            retVal = 'Exported';
        end %function
    end %methods
    
end %classdef

1. Open the model ex_pattern_enum that has an Enumerated Constant block and a Multiport
Switch block.

2. In the Model Data Editor, select the Parameters tab.

3. In the model, click the Enumerated Constant block.
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4. In the Model Data Editor, use the Value column to set the constant value to myChoice. Next to
myChoice, click the action button (with three vertical dots) and select Create.

5. In the Create New Data dialog box, set Value to
Simulink.Parameter(ex_myEnumType.Choice1) and click Create. A Simulink.Parameter
object named myChoice appears in the base workspace. The object stores the enumerated value
Choice1 of the type ex_myEnumType.

6. On the Code Generation tab, set Storage Class to ExportedGlobal. With this setting, the
object appears in the generated code as a global variable.

7. In the Model Data Editor, select the Signals tab.

8. In the model, select the output signal of the Enumerated Constant block.

9. In the Model Data Editor, use the Data Type column to set the signal data type to Enum:
ex_myEnumType.

10. Select the Multiport Switch block.

11. In the Property Inspector, set:

• Data port order to Specify indices.
• Data port indices to enumeration('ex_myEnumType'). This expression returns all of the

enumeration members of ex_myEnumType.

12. Set the model configuration parameter File packaging format to Modular. With this setting, in
the generated code, the definition of ex_myEnumType can appear in the specified header file,
myEnumHdr.h.

13. To build the model and generate code, press Ctrl+B .

Results

View the generated header file myEnumHdr.h. The file defines the enumerated data type.

typedef enum {
  Choice1 = 0,                         /* Default value */
  Choice2
} ex_myEnumType;

View the source file ex_pattern_enum.c. The file defines the variable myChoice. The algorithm in
the step function uses myChoice to route one of the input signals to the output signal.

ex_myEnumType myChoice = Choice1;      /* Variable: myChoice

/* Model step function */
void ex_pattern_enum_step(void)
{
  /* MultiPortSwitch: '<Root>/Multiport Switch' incorporates:
   *  Constant: '<S1>/Constant'
   */
  if (myChoice == Choice1) {
    /* Outport: '<Root>/Data Out' incorporates:
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     *  Inport: '<Root>/Data In 1'
     */
    rtY.DataOut = rtU.DataIn1;
  } else {
    /* Outport: '<Root>/Data Out' incorporates:
     *  Inport: '<Root>/Data In 2'
     */
    rtY.DataOut = rtU.DataIn2;
  }

  /* End of MultiPortSwitch: '<Root>/Multiport Switch' */
}

See Also
enumeration

Related Examples
• “Use Enumerated Data in Simulink Models”
• “Use Enumerated Data in Generated Code” on page 34-84
• “Define Enumerated Data Types” (Stateflow)
• “Define Enumerations for MATLAB Function Blocks”
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If-Else
This example shows how to implement an if-else construct by using Simulink blocks, Stateflow
Charts, and MATLAB Function block.

C Construct

if (u1 > u2)
{
  y1 = u1;
}
else
{
  y1 = u2;
}

Modeling Pattern for If-Else: Switch block

One method to create an if-else statement is to use a Switch block from the Simulink > Signal
Routing library.

1. Open example model ex_if_else_SL.

The model contains the Switch block with the block parameter Criteria for passing first input of
u2~=0. The software selects u1 if u2 is TRUE, otherwise u2 passes.

2. To build the model and generate code, press Ctrl+B.

The code implementing the if-else construct is in the ex_if_else_SL_step function in
ex_if_else_SL.c:

/* External inputs (root inport signals with default storage) */
ExternalInputs U;

/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs Y;

/* Model step function */
void ex_if_else_SL_step(void)
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{
  /* Switch: '<Root>/Switch' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   *  RelationalOperator: '<Root>/Relational Operator'
   */
  if (U.u1 > U.u2) {
    /* Outport: '<Root>/y1' */
    Y.y1 = U.u1;
  } else {
    /* Outport: '<Root>/y1' */
    Y.y1 = U.u2;
  }

  /* End of Switch: '<Root>/Switch' */
}

Modeling Pattern for If-Else: Stateflow Chart

1. Open example model ex_if_else_SF.

The model contains an If-Else decision pattern that you add by right clicking inside the chart >
Add Pattern in Chart > Decision > If-Else.

2. To build the model and generate code, press Ctrl+B.

The code implementing the if-else construct is in the ex_if_else_SF_step function in
ex_if_else_SF.c:

/* External inputs (root inport signals with default storage) */
ExternalInputs U;

/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs Y;

/* Model step function */
void ex_if_else_SF_step(void)
{
  /* Chart: '<Root>/Chart' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
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   */
  /*  If-Else  */
  if (U.u1 > U.u2) {
    /* Outport: '<Root>/y1' */
    Y.y1 = U.u1;
  } else {
    /* Outport: '<Root>/y1' */
    Y.y1 = U.u2;
  }

  /* End of Chart: '<Root>/Chart' */
}

Modeling Pattern for If-Else: MATLAB Function Block

1. Open example model ex_if_else_ML.

2. The MATLAB Function Block contains this function:

function y1 = fcn(u1, u2)
if u1 > u2;
    y1 = u1;
else y1 = u2;
end

2. To build the model and generate code, press Ctrl+B.

The code implementing the if-else construct is in the ex_if_else_ML_step function in
ex_if_else_ML.c:

/* External inputs (root inport signals with default storage) */
ExternalInputs U;

/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs Y;

/* Model step function */
void ex_if_else_ML_step(void)
{
  /* MATLAB Function: '<Root>/MATLAB Function' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  if (U.u1 > U.u2) {
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    /* Outport: '<Root>/y1' */
    Y.y1 = U.u1;
  } else {
    /* Outport: '<Root>/y1' */
    Y.y1 = U.u2;
  }

  /* End of MATLAB Function: '<Root>/MATLAB Function' */
}

See Also

Related Examples
• “Switch” on page 25-27
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Switch
This example shows how to implement a switch construct by using Simulink blocks, Stateflow
Charts, and MATLAB Function block.

C Construct

switch (u1)
{
 case 2:
   y1 = u2;
   break;
 case 3:
   u3;
   break;
 default:
   y1 = u4;
   break;
}

Modeling Pattern for Switch: Switch Case block

One method to create a switch statement is to use a Switch Case block from the Simulink > Signal
Routing library.

1. Open example model ex_switch_SL.

The model contains a Switch Case Action Subsystem. The Switch Case block takes an integer input,
therefore, the input signal u1 is type cast to int32.

2. To build the model and generate code, press Ctrl+B.
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The code implementing the switch construct is in the ex_switch_SL_step function in
ex_switch_SL.c:

/* Exported block signals */
int32_T u1;                            /* '<Root>/u1' */

/* External inputs (root inport signals with default storage) */
ExternalInputs rtU;

/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs rtY;

/* Model step function */
void ex_switch_SL_step(void)
{
  /* SwitchCase: '<Root>/Switch Case' incorporates:
   *  Inport: '<Root>/u1'
   */
  switch (u1) {
   case 2:
    /* Outputs for IfAction SubSystem: '<Root>/Switch Case Action Subsystem' incorporates:
     *  ActionPort: '<S1>/Action Port'
     */
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u2'
     *  Inport: '<S1>/u2'
     */
    rtY.y1 = rtU.u2;

    /* End of Outputs for SubSystem: '<Root>/Switch Case Action Subsystem' */
    break;

   case 3:
    /* Outputs for IfAction SubSystem: '<Root>/Switch Case Action Subsystem1' incorporates:
     *  ActionPort: '<S2>/Action Port'
     */
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u3'
     *  Inport: '<S2>/u3'
     */
    rtY.y1 = rtU.u3;

    /* End of Outputs for SubSystem: '<Root>/Switch Case Action Subsystem1' */
    break;

   default:
    /* Outputs for IfAction SubSystem: '<Root>/Switch Case Action Subsystem2' incorporates:
     *  ActionPort: '<S3>/Action Port'
     */
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u4'
     *  Inport: '<S3>/u4'
     */
    rtY.y1 = rtU.u4;

    /* End of Outputs for SubSystem: '<Root>/Switch Case Action Subsystem2' */
    break;
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  }

  /* End of SwitchCase: '<Root>/Switch Case' */
}

Modeling Pattern for Switch: MATLAB Function Block

1. Open example model ex_switch_ML.

The MATLAB Function Block contains this function:

function y1 = fcn(u1, u2, u3, u4)

switch u1
    case 2
        y1 = u2;
    case 3
        y1 = u3;
    otherwise
        y1 = u4;
end

2. To build the model and generate code, press Ctrl+B.

The code implementing the switch construct is in the ex_switch_ML_step function in
ex_switch_ML.c:

/* External inputs (root inport signals with default storage) */
ExternalInputs rtU;

/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs rtY;

/* Model step function */
void ex_switch_ML_step(void)
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{
  /* MATLAB Function: '<Root>/MATLAB Function' incorporates:
   *  Inport: '<Root>/u1'
   */
  switch (rtU.u1) {
   case 2:
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u2'
     */
    rtY.y1 = rtU.u2;
    break;

   case 3:
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u3'
     */
    rtY.y1 = rtU.u3;
    break;

   default:
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u4'
     */
    rtY.y1 = rtU.u4;
    break;
  }

  /* End of MATLAB Function: '<Root>/MATLAB Function' */
}

Convert If-Elseif-Else to Switch statement

If a MATLAB Function block or a Stateflow chart uses if-elseif-else decision logic, you can
convert the block or chart to a switch statement by using a configuration parameter. Select the
Configuration Parameters > Code Generation > Code Style > “Convert if-elseif-else patterns
to switch-case statements” parameter. For more information, see “Converting If-Elseif-Else Code to
Switch-Case Statements”. For more information on this conversion by using a Stateflow chart, see
“Enhance Readability of Code for Flow Charts” on page 53-91.

See Also
Switch Case

Related Examples
• “If-Else” on page 25-23
• “Enumeration” on page 25-20
• “Create Flow Charts by Using Pattern Wizard” (Stateflow)
• “Implementing MATLAB Functions Using Blocks”
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For Loop
This example shows how to implement a for loop construct by using Simulink blocks, Stateflow
Charts, and MATLAB Function blocks.

C Construct

y1 = 0;
for(inx = 0; inx <10; inx++)
{
  y1 = u1[inx] + y1;
}

Modeling Pattern for For Loop: For-Iterator Subsystem block

One method for creating a for loop is to use a For Iterator Subsystem block from the Simulink >
Ports and Subsystems library.

1. Open example model ex_for_loop_SL.

The model contains a For Iterator Subsystem block that repeats execution of the contents of the
subsystem during a simulation time step.

Observe the following settings in the model:

• Open the For Iterator block. In the Block Parameters dialog box, the Index-mode parameter is
Zero-based and the Iteration limit parameter is 10.

• Open the Unit Delay block. In the Block Parameters dialog box, the Initial Conditions parameter
is 0. This parameter initializes the state to zero.

2. To build the model and generate code, press Ctrl+B.

The code implementing the for loop is in the ex_for_loop_SL_step function in
ex_for_loop_SL.c:

/* External inputs (root inport signals with default storage) */
ExternalInputs U;
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/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs Y;

/* Model step function */
void ex_for_loop_SL_step(void)
{
  int32_T rtb_y1;
  int32_T s1_iter;

  /* Outputs for Iterator SubSystem: '<Root>/For Iterator Subsystem' incorporates:
   *  ForIterator: '<S1>/For Iterator'
   */
  for (s1_iter = 0; s1_iter < 10; s1_iter++) {
    /* Sum: '<S1>/Add' incorporates:
     *  Inport: '<Root>/u1'
     *  MultiPortSwitch: '<S1>/Index Vector'
     *  UnitDelay: '<S1>/Unit Delay'
     */
    rtb_y1 = U.u1[s1_iter] + DWork.UnitDelay_DSTATE;

    /* Update for UnitDelay: '<S1>/Unit Delay' */
    DWork.UnitDelay_DSTATE = rtb_y1;
  }

  /* End of Outputs for SubSystem: '<Root>/For Iterator Subsystem' */

  /* Outport: '<Root>/y1' */
  Y.y1 = rtb_y1;
}

Modeling Pattern for For Loop: Stateflow Chart

1. Open example model ex_for_loop_SF.

The chart contains a For loop decision pattern that you add by right clicking inside the chart > Add
Pattern in Chart > Loop > For.

2. To build the model and generate code, press Ctrl+B.

The code implementing the for loop is in the ex_for_loop_SF_step function in
ex_for_loop_SF.c:

/* External inputs (root inport signals with default storage) */
ExternalInputs U;
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/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs Y;

/* Model step function */
void ex_for_loop_SF_step(void)
{
  int32_T inx;

  /* Chart: '<Root>/Chart' */
  for (inx = 0; inx < 10; inx++) {
    /* Outport: '<Root>/y1' incorporates:
     *  Inport: '<Root>/u1'
     */
    Y.y1 += U.u1[inx];
  }

  /* End of Chart: '<Root>/Chart' */
}

Modeling Pattern for For Loop: MATLAB Function block

1. Open example model ex_for_loop_ML.

The MATLAB Function Block contains this function:

function y1 = fcn(u1)
 
y1 = 0;
 
for inx=1:10
    y1 = u1(inx) + y1 ;
end

2. To build the model and generate code, press Ctrl+B.

The code implementing the for loop is in the ex_for_loop_ML_step function in
ex_for_loop_ML.c:

/* Exported block signals */
real_T u1[10];                         /* '<Root>/u1' */
real_T y1;                             /* '<Root>/MATLAB Function' */

/* Model step function */
void ex_for_loop_ML_step(void)
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{
  int32_T inx;

  /* MATLAB Function: '<Root>/MATLAB Function' incorporates:
   *  Inport: '<Root>/u1'
   */
  y1 = 0.0;
  for (inx = 0; inx < 10; inx++) {
    y1 += u1[inx];
  }

  /* End of MATLAB Function: '<Root>/MATLAB Function' */
}

See Also
For Iterator Subsystem

Related Examples
• “Create Flow Charts by Using Pattern Wizard” (Stateflow)

More About
• “Implementing MATLAB Functions Using Blocks”
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While Loop
This example shows how to implement a while loop construct by using Simulink blocks, Stateflow
Charts, and MATLAB Function blocks.

C Construct

while(flag && (num_iter <= 100)
{
  flag = func ();
  num_iter ++;
}

Modeling Pattern for While Loop: While Iterator Subsystem block

One method for creating a while loop is to use a While Iterator Subsystem block from the Simulink
> Ports and Subsystems library.

1. Open example model ex_while_loop_SL.

The model contains a While Iterator Subsystem block that repeats execution of the contents of the
subsystem during a simulation time step.

Observe the following settings in the model:
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• The Constant block provides an initial condition to the While Iterator Subsystem. For the Constant
block, the Constant value is 1 and the Output data type is boolean. The initial condition can
be dependent on the input to the block.

• In the While Iterator Subsystem, the func subsystem block has an output flag of 0 or 1
depending on the result of the algorithm in func( ). func() is the Function name in func
subsystem.

• In the While Iterator Subsystem, for the While Iterator block, the Maximum number of
iterations is 100.

• For the While Iterator block, the While loop type is while.

2. To build the model and generate code, press Ctrl+B.

The code implementing the while loop is in the ex_while_loop_SL_step function in
ex_while_loop_SL.c:

/* Model step function */
void ex_while_loop_SL_step(void)
{
  int32_T s1_iter;
  boolean_T loopCond;

  /* Outputs for Iterator SubSystem: '<Root>/While Iterator Subsystem' incorporates:
   *  WhileIterator: '<S1>/While Iterator'
   */
  s1_iter = 1;

  /* SystemReset for Atomic SubSystem: '<S1>/func' */
  func_Reset();

  /* End of SystemReset for SubSystem: '<S1>/func' */
  loopCond = true;
  while (loopCond && (s1_iter <= 100)) {
    /* Outputs for Atomic SubSystem: '<S1>/func' */
    func();

    /* End of Outputs for SubSystem: '<S1>/func' */
    loopCond = flag;
    s1_iter++;
  }

  /* End of Outputs for SubSystem: '<Root>/While Iterator Subsystem' */
}

Modeling Pattern for While Loop: Stateflow Chart

1. Open example model ex_while_loop_SF.
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In the model, the ex_while_loop_SF/Chart executes the while loop.

The chart contains a While loop decision pattern that you add by right clicking inside the chart >
Add Pattern in Chart > Loop > While.

2. To build the model and generate code, press Ctrl+B.

The code implementing the while loop is in the ex_while_loop_SF_step function in
ex_while_loop_SF.c:

/* Model step function */
void ex_while_loop_SF_step(void)
{
  /* Chart: '<Root>/Chart' */
  num_iter = 1;
  while (flag && (num_iter <= 100)) {
    /* Outputs for Function Call SubSystem: '<Root>/func' */
    func();

    /* End of Outputs for SubSystem: '<Root>/func' */
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    num_iter++;
  }

  /* End of Chart: '<Root>/Chart' */
}

Modeling Pattern for For Loop: MATLAB Function block

1. Open example model ex_while_loop_ML.

The MATLAB Function Block contains this function:

function fcn(func_flag)

flag = true; 
num_iter = 1;

while(flag && (num_iter<=100))
    func;
    flag = func_flag;
    num_iter = num_iter + 1;
end

2. To build the model and generate code, press Ctrl+B.

The code implementing the while loop is in the ex_while_loop_ML_step function in
ex_while_loop_ML.c:

/* Model step function */
void ex_while_loop_ML_step(void)
{
  int32_T num_iter;
  boolean_T flag;
  boolean_T func_flag_0;

  /* MATLAB Function: '<Root>/MATLAB Function' */
  func_flag_0 = func_flag;
  flag = true;
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  num_iter = 1;
  while (flag && (num_iter <= 100)) {
    /* Outputs for Function Call SubSystem: '<Root>/func' */
    func();

    /* End of Outputs for SubSystem: '<Root>/func' */
    flag = func_flag_0;
    num_iter++;
  }

  /* End of MATLAB Function: '<Root>/MATLAB Function' */
}

See Also
While Iterator Subsystem

Related Examples
• “Do While Loop” on page 25-40
• “Create Flow Charts by Using Pattern Wizard” (Stateflow)

More About
• “Implementing MATLAB Functions Using Blocks”
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Do While Loop
This example shows how to implement a do while loop construct by using Simulink blocks and
Stateflow Charts.

C Construct

num_iter = 1;
do {
   flag = func();
   num_iter++;
   }
while (flag && num_iter <= 100)

Modeling Pattern for Do While Loop: While Iterator Subsystem block

One method for creating a do while loop is to use a While Iterator Subsystem block from the
Simulink > Ports and Subsystems library.

1. Open example model ex_do_while_loop_SL.

The model contains a While Iterator Subsystem block that repeats execution of the contents of the
subsystem during a simulation time step.

Observe the following settings in the While Iterator Subsystem:

• The func subsystem block has an output flag of 0 or 1 depending on the result of the algorithm
in func( ). func() is the Function name in func subsystem.

• For the While Iterator block, the Maximum number of iterations is 100.

• For the While Iterator block, the While loop type is do-while.

2. To build the model and generate code, press Ctrl+B.

The code implementing the do while loop is in the ex_do_while_loop_SL_step function in
ex_do_while_loop_SL.c:

/* Model step function */
void ex_do_while_loop_SL_step(void)
{
  int32_T s1_iter;

  /* Outputs for Iterator SubSystem: '<Root>/While Iterator Subsystem' incorporates:
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   *  WhileIterator: '<S1>/While Iterator'
   */
  s1_iter = 1;

  /* SystemReset for Atomic SubSystem: '<S1>/func' */
  func_Reset();

  /* End of SystemReset for SubSystem: '<S1>/func' */
  /* End of Outputs for SubSystem: '<Root>/While Iterator Subsystem' */
  do {
    func();
    s1_iter++;
  } while (flag && (s1_iter <= 100));
}

Modeling Pattern for Do While Loop: Stateflow Chart

1. Open example model ex_do_while_loop_SF.

In the model, the ex_do_while_loop_SF/Chart executes the do while loop.
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The chart contains a While loop decision pattern that you add by selecting Chart > Add Pattern in
Chart > Loop > While.

2. To build the model and generate code, press Ctrl+B.

The code implementing the do while loop is in the ex_do_while_loop_SF_step function in
ex_do_while_loop_SF.c:

/* Model step function */
void ex_do_while_loop_SF_step(void)
{
  int32_T num_iter;

  /* Chart: '<Root>/Chart' */
  num_iter = 1;
  do {
    func();
    num_iter++;
  } while (flag && (num_iter <= 100));
}

See Also
While Iterator Subsystem

Related Examples
• “While Loop” on page 25-35
• “Create Flow Charts by Using Pattern Wizard” (Stateflow)
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Function Call
This example shows how to generate a function call by adding a subsystem, which implements the
operations that you want.

C Construct

void add_function(void)
{ 
   y1 = u1 + u2;
}

Procedure

1. Open example model ex_function_call.

The subsystem has two inputs and returns one output.

Selecting the Treat as atomic unit parameter enables parameters on the Code Generation tab.
The Code Generation tab provides these customizations:

• Function packaging set to Nonreusable function
• Function name options set to User specified
• Function name specified as add_function
• File name options set to Use function name

2. To build the model and generate code, press Ctrl+B.

Results

In ex_function_call.c, the function is called from ex_function_call_step:

/* Model step function */
void ex_function_call_step(void)
{
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  /* Outputs for Atomic SubSystem: '<Root>/Add_Subsystem' */
  add_function();

  /* End of Outputs for SubSystem: '<Root>/Add_Subsystem' */
}

The function prototype is externally declared through the subsystem file, add_function.h:

extern void add_function(void);

The function definition is in the subsystem file add_function.c:

void add_function(void)
{
  /* Outport: '<Root>/y1' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   *  Sum: '<S1>/Sum'
   */
  rtY.y1 = u1 + u2;
}

See Also
Function-Call Subsystem

Related Examples
• “Generate Reentrant Code from Subsystems”
• “Conditionally Executed Subsystems Overview”
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Function Prototyping
This example shows how to create and customize your function prototype.

C Construct

double add_function(double u1, double u2)
{ 
   return u1 + u2;
}

Function Call by Using Graphical Functions

1. Open example model ex_func_SF. This example model contains two Inport blocks and one
Outport block.

The Stateflow chart contains a graphical function that you create by clicking the fx button and
placing a graphical function into the Stateflow chart.

The graphical function contains this signature:

output = add_function(u1, u2)

In the Stateflow chart, there is an example of a simple transition that calls add_function.

 Function Prototyping

25-45

matlab:ex_func_SF


2. Open the Model Explorer. From the Model Hierarchy tree, select ex_func_SF > Chart >
add_function. On the right pane, make sure that the Function Inline Option is set as Function.

3. From the Model Hierarchy tree, click Chart. On the right pane make sure that the Export Chart
Level Functions parameter is selected.

4. To build the model and generate code, press Ctrl+B.

ex_func_SF.c contains the generated code:

/* Function for Chart: '<Root>/Chart' */
void add_function(real_T in1, real_T in2, real_T *output)
{
  *output = in1 + in2;
}

/* Model step function */
void ex_func_SF_step(void)
{
  /* Chart: '<Root>/Chart' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  add_function(u1, u2, &y1);

  /* Outport: '<Root>/y1' */
  rtY.y1_e = y1;
}

Control Function Prototype of the model_step Function

1. Open example model ex_control_step_function.

2. Open the Code perspective. In the Code Mappings editor, select the Entry-Point Functions tab.

3. In the step function row, under the Function Preview column, click the prototype hyperlink. The
configuration dialog box used for customization opens. The first field in the dialog box, C function
prototype, automatically updates to preview the changes to the step function as you make them.

4. Change the function name. If you do not specify a name, the code generator names the function
based on a default naming rule. For this example, rename the function by setting C Step Function
Name to ex_control_run. The function preview changes to reflect the new step function name.

5. Configure step function arguments. If an application requires a void-void interface, clear
Configure arguments for Step function prototype. For this example, select that option.

6. Display current default settings for the entry-point function arguments by clicking Get default. An
updated diagram appears.
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7. Configure the function return argument by setting C return argument to void or one of the
listed outport arguments. For this example, select void. Check your change in the preview.

8. Configure the function input and output arguments. For each root inport and outport, you can
change the C type qualifier and argument name. For details, see “Configure Name and Arguments for
Individual Step Functions” on page 33-118.

For this example:

• For u1, set C Type Qualifier to Value and C Identifier Name to arg_u1.

• For u2, set C Type Qualifier to Pointer to const and C Identifier Name to arg_u2.

• For the outport, set C Identifier Name to arg_y1.

Review your changes in the preview.

9. To validate your changes, click Validate.

10. Apply your changes. Click Apply. Then, click OK.

11. To build the model and generate code, press Ctrl+B.

ex_control_step_function.c contains the generated code:

void ex_control_run(real_T arg_u1, const real_T *arg_u2, real_T *arg_y1)

See Also

Related Examples
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Choose an Approach for Configuring Generated C Function Interfaces” on page 33-116
• “Reuse Logic Patterns by Defining Graphical Functions” (Stateflow)
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External C Functions
This example shows several methods for integrating legacy C functions into generated code. These
methods create an S-function or make a call to an external C function. For more information on S-
functions, see “S-Functions and Code Generation” on page 13-2.

C Construct

extern double add(double, double);

#include "add.h"
double add(double u1, double u2)
{
   double y1;
   y1 = u1 + u2;
   return (y1);
}

Create S-Functions by Using Legacy Code Tool

Use the Legacy Code Tool to create an S-function and generate a TLC file. The code generation
software uses the TLC file to generate code from this S-function. The advantage to using the Legacy
Code Tool is that the generated code is fully inlined and does not need wrapper functions to access
the custom code.

1. Create a C header file named add.h that contains the function signature:

extern double add(double, double);

2. Create a C source file named add.c that contains the function body:

double add(double u1, double u2)
{
   double y1;
   y1 = u1 + u2;
   return (y1);
}

3. To build an S-function for use in simulation and code generation, run the following script or
execute each of these commands at the MATLAB command line:

%% Initialize legacy code tool data structure
def = legacy_code('initialize');

%% Specify Source File
def.SourceFiles = {'add.c'};

%% Specify Header File
def.HeaderFiles = {'add.h'};

%% Specify the Name of the generated S-function
def.SFunctionName = 'add_function';
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%% Create a c-mex file for S-function
legacy_code('sfcn_cmex_generate', def);

%% Define function signature and target the Output method
def.OutputFcnSpec = ['double y1 = add(double u1, double u2)'];

%% Compile/Mex and generate a block that can be used in simulation
legacy_code('generate_for_sim', def);

%% Create a TLC file for Code Generation
legacy_code('sfcn_tlc_generate', def);

%% Create a Masked S-function Block 
legacy_code('slblock_generate', def);

### Start Compiling add_function
    mex('-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\4\tpabb6e641\ex61094511', '-c', '-outdir', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\4\tpfe65bd88_e64c_4822_a88d_fe0a9971ace0', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\4\tpabb6e641\ex61094511\add.c')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
    mex('add_function.c', '-IC:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\4\tpabb6e641\ex61094511', 'C:\TEMP\Bdoc21a_1606923_3504\ib7FC80E\4\tpfe65bd88_e64c_4822_a88d_fe0a9971ace0\add.obj')
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Finish Compiling add_function
### Exit

The output of this script produces:

• A new model containing the S-function block.
• A TLC file named add_function.tlc.
• A C source file named add_function.c.
• A mexw32 dll file named add_function.mexw32.

4. Add inport blocks and an outport block and make the connections, as shown in the model.

5. Name and save your model. In this example, the model is named ex_function_call_lct.

6. To build the model and generate code, press Ctrl+B.

This code is generated in ex_function_call_lct.c:

/* Exported block signals */
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real_T u1;                             /* '<Root>/u1' */
real_T u2;                             /* '<Root>/u2' */

/* External outputs (root outports fed by signals with default storage) */
ExternalOutputs rtY;

/* Model step function */
void ex_function_call_lct_step(void)
{
  /* Outport: '<Root>/y1' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   *  S-Function (add_function): '<Root>/add_function'
   */
  rtY.y1 = add(u1, u2);
}

The user-specified header file add.h is included in ex_function_call_lct.h:

#include "add.h"

Call C Functions by Using a Stateflow Chart

1. Create a C header file named add.h that contains the example function signature. Refer to the
preceding example.

2. Create a C source file named add.c that contains the function body. Refer to the preceding
example.

3. Add inport blocks and an outport block and make the connections, as shown in the model. In this
example, the model is named ex_function_call_SF.

4. Double-click the Stateflow chart and edit the chart as shown. Place the call to the add function
within a transition action.
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5. Select the Configuration Parameters > Simulation Target > Custom Code pane. In the
Include custom C code in generated section, on the left pane, select Header file. In the Header
file field, enter the #include statement:

#include "add.h"

6. In the Additional build information section, select Source files. In the Source files field, enter:

add.c

7. Select the Configuration Parameters > Simulation Target > Custom Code > Use the same
custom code settings as Simulation Target parameter.

8. To build the model and generate code, press Ctrl+B.

ex_exfunction_call_SF.c contains the following code in the step function:

/* Definition for custom storage class: Global */
real_T u1;                             /* '<Root>/u1' */
real_T u2;                             /* '<Root>/u2' */
real_T y1;                             /* '<Root>/Chart' */

/* Model step function */
void ex_function_call_SF_step(void)
{
  /* Chart: '<Root>/Chart' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  y1 = (real_T)add(u1, u2);
}

ex_exfunction_call_SF.h contains the include statement for add.h:

#include "add.h"

Use MATLAB Function Block to Call C Functions

1. Create a C header file named add.h that contains the example function signature. Refer to the
preceding example.
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2. Create a C source file named add.c that contains the function body. Refer to the preceding
example.

3. In the Simulink Library Browser, click Simulink > User Defined Functions. Drag a MATLAB
Function block into your model.

4. Double-click the MATLAB Function block. Edit the function to include:

function y1 = add_function(u1, u2)

% Set the class and size of output
y1 = u1; 

% Call external C function
y1 = coder.ceval('add',u1,u2);

end

5. Select the Configuration Parameters > Simulation Target > Custom Code pane. In the
Include custom C code in generated section, on the left pane, select Header file. In the Header
file field, enter the #include statement:

#include "add.h"

6. In the Additional build information section, select Source files. In the Source files field, enter:

add.c

7. Add two Inport blocks and one Outport block to the model and connect it to the MATLAB Function
block.

8. Save the model as ex_function_call_ML.

9. To build the model and generate code, press Ctrl+B.

ex_exfunction_call_ML.c contains the following code in the step function:

/* Definition for custom storage class: Global */
real_T u1;                             /* '<Root>/u1' */
real_T u2;                             /* '<Root>/u2' */
real_T y1;                             /* '<Root>/MATLAB Function' */

/* Model step function */
void ex_function_call_ML_step(void)
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{
  /* MATLAB Function: '<Root>/MATLAB Function' incorporates:
   *  Inport: '<Root>/u1'
   *  Inport: '<Root>/u2'
   */
  y1 = add(u1, u2);
}

ex_exfunction_call_ML.h contains the include statement for add.h:

#include "add.h"

See Also

Related Examples
• “Call C Library Functions in C Charts” (Stateflow)
• “When to Generate Code from MATLAB Algorithms”
• “Legacy Code Tool and Code Generation”
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Macro Definitions (#define)
C Construct

#define myParam 9.8;

Export Generated Macro Definition

1. Open example model ex_param_macro.

2. In the model, select the Gain block. In the Property Inspector, set the value of the Gain parameter
to myParam.

3. Next to the parameter value, click the action button (the button with three vertical dots) and select
Create.

4. In the Create New Data dialog box, set Value to Simulink.Parameter(9.8). Click Create. A
Simulink.Parameter object, myParam, appears in the base workspace. The Gain block uses the
object to set the value of the Gain parameter, in this case, 9.8.

5. On the Code Generation tab, click the Configure in Coder App button. In the Code Mappings
editor, set Storage Class to Define. Click OK.

6. To build the model and generate code, press Ctrl+B .

The generated header file ex_param_macro.h defines myParam as a macro.

/* Definition for custom storage class: Define */
#define myParam                        9.8                       /* Referenced by: '<Root>/Gain' */

Reuse Macro from Handwritten Code

1. In the Code Mappings editor, on the Parameters tab, click the Update Code Mappings button.

2. Change Storage Class of myParam from Define to ImportedDefine.

3. In the Property Inspector, under Code section, set Header File to external_params.h. The
generated code imports the macro definition from a custom header file named external_params.h.

4. In your current folder, create the C header file external_params.h, which contains the #define
statement.

#ifndef _EXTERNAL_PARAMS
#define _EXTERNAL_PARAMS

#define myParam 9.8

#endif
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/* EOF */

5. To build the model and generate code, press Ctrl+B .

The generated header file ex_param_macro.h does not define the macro. Instead, the file includes
(#include) the custom header file external_params.h.

/* Includes for objects with custom storage classes. */
#include "external_params.h"

The source file ex_param_macro.c contains a guard to check that a definition for myParam exists.

/*
 * Check that imported macros with storage class "ImportedDefine" are defined
 */
#ifndef myParam
#error The variable for the parameter "myParam" is not defined
#endif

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
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Conditional Inclusions (#if / #endif)
You can generate preprocessor conditional directives in your code by implementing Variant
Subsystem blocks in your model. In the generated code, preprocessor conditional directives select a
section of code to execute at compile time. To implement variants in your model, see “Create a Simple
Variant Model”. To generate code for variants, see “Generate Preprocessor Conditionals for Variant
Systems” on page 26-31.
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Typedef
Create data type aliases by generating typedef statements.

C Construct

typedef float float_32;

Procedure

To create a data type alias in Simulink®, use a Simulink.AliasType. The code generator creates a
typedef statement in the generated code.

The built-in Simulink data type single corresponds to the C data type float.

1. At the command prompt, create a Simulink.AliasType object named float_32 that represents
an alias of single.

float_32 = Simulink.AliasType('single');

float_32 = Simulink.AliasType('single');

2. Open the example model ex_typedef.

ex_typedef

3. In the Model Data Editor, open the Inports/Outports tab.

4. From the Change View menu, select Design.

5 In the model, select the Inport block.

6. In the Model Data Editor, for the Inport block, set Data Type to float_32.

set_param('ex_typedef/In1','OutDataTypeStr','float_32');

7. Open the Embedded Coder app.

8. In the C Code tab, select Code Interface > Individual Element Code Mappings.

9. In the Code Mappings editor, on the Inports tab, set Storage Class for the Inport block to
ExportedGlobal. The Inport block appears in the generated code as a separate global variable.

10. In the Property Inspector, for the Inport block, set the Code > Identifier property to mySig.

cm = coder.mapping.api.get('ex_typedef');
setInport(cm,'In1','StorageClass','ExportedGlobal','Identifier','mySig');

11. To build the model and generate code, press Ctrl+B .

currentDir = pwd;
[~,cgDir] = rtwdemodir();
evalc('slbuild(''ex_typedef'')');
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Results

The generated header file ex_typedef.h defines the data type alias float_32.

file = fullfile('ex_typedef_ert_rtw','ex_typedef.h');
rtwdemodbtype(file,'#ifndef DEFINED_TYPEDEF_FOR_float_32_', ...
    '/* External outputs',1,1);

#ifndef DEFINED_TYPEDEF_FOR_float_32_
#define DEFINED_TYPEDEF_FOR_float_32_

typedef real32_T float_32;

#endif

By default, the code generator also creates the alias real32_T, which corresponds to the C data type
float. You can see the typedef statement in the generated header file rtwtypes.h.

file = fullfile('ex_typedef_ert_rtw','rtwtypes.h');
rtwdemodbtype(file,'typedef float real32_T;', ...
    'typedef float real32_T;',1,1);

typedef float real32_T;

The generated source file ex_typedef.c uses float_32 to define the global variable mySig.

file = fullfile('ex_typedef_ert_rtw','ex_typedef.c');
rtwdemodbtype(file,'/* Exported block signals */', ...
    '/* External outputs',1,1);

/* Exported block signals */
float_32 mySig;                        /* '<Root>/In1' */

See Also
Simulink.AliasType

Related Examples
• “Control Data Type Names in Generated Code” on page 36-2
• “Structures of Signals” on page 25-62
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Structures of Parameters
Create a structure in the generated code. The structure stores parameter data.

C Construct

typedef struct {
  double G1;
  double G2;
} myStructType;

myStructType myStruct = {
  2.0,
  -2.0
} ; 

Procedure

1. Open the example model rtwdemo_paraminline.

2. On the Modeling tab, click Model Data Editor. In the Model Data Editor, select the Parameters
tab.

3. In the model, click the Gain block labeled G1. In the Model Data Editor, use the Value column to
set the value of the Gain parameter to myStruct.G1.

4. Set the value of the Gain parameter in the G2 block to myStruct.G2.

5. Next to myStruct.G2, click the action button (with three vertical dots) and select Create.

6. In the Create New Data dialog box, set Value to Simulink.Parameter(struct) and click
Create. A Simulink.Parameter object named myStruct appears in the base workspace.
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7. In the Simulink.Parameter property dialog box, next to the Value property, click the action button
and select Open Variable Editor.

8. Right-click the white space under the Field column and select New. Name the new structure field
G1. Use the Value column to set the value of the field to 2.

9. Add a field G2 whose value is -2, and then close the Variable Editor.

10. In the Simulink.Parameter property dialog box, on the Code Generation tab, set Storage class
to ExportedGlobal. The structure myStruct appears in the generated code as a global variable.

11. Generate code from the model.

Results

The generated header file rtwdemo_paraminline_types.h defines a structure type that has a
random name.

typedef struct {
  real_T G1;
  real_T G2;
} struct_6h72eH5WFuEIyQr5YrdGuB;

The source file rtwdemo_paraminline.c defines and initializes the structure variable myStruct.

/* Exported block parameters */
struct_6h72eH5WFuEIyQr5YrdGuB myStruct = {
  2.0,
  -2.0
} ;                                    /* Variable: myStruct
                                        * Referenced by:
                                        *   '<Root>/G1'
                                        *   '<Root>/G2'
                                        */

Specify Name of Structure Type

1. Optionally, specify a name to use for the structure type definition (struct). At the command
prompt, use the function Simulink.Bus.createObject to create a Simulink.Bus object that
represents the structure type.

2. The default name of the object is slBus1. Change the name by copying the object into a new
MATLAB variable.

3. In the Model Data Editor, click the Show/refresh additional information button.

4. In the data table, find the row that corresponds to myStruct. Use the Data Type column to set the
data type of myStruct to Bus: myStructType.

5. Generate code from the model.

The code generates the definition of the structure type myStructType and uses this type to define
the global variable myStruct.
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myStructType myStruct = {
  2.0,
  -2.0
} ;                                    /* Variable: myStruct

See Also

Related Examples
• “Organize Data into Structures in Generated Code” on page 34-145
• “Configure Parameters for C Code Generation” on page 33-62
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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Structures of Signals
This example shows how to create a structure of signal data in the generated code.

C Construct

typedef struct {
   double signal1;
   double signal2;
   double signal3;
} my_signals_type;

Procedure

To represent a structure type in a model, create a Simulink.Bus object. Use the object as the data
type of bus signals in your model.

1. Create the ex_signal_struct model by using Gain blocks, a Bus Creator block, and a Unit Delay
block. The Gain and Unit Delay blocks make the structure more identifiable in the generated code.

2. To configure the Bus Creator block to accept three inputs, in the block dialog box, set Number of
inputs to 3.

3. In the toolstrip, on the Modeling tab, under Design, click Bus Editor.

4. In the Bus Editor, click File > Add Bus to create a Simulink.Bus object and name it
my_signals_type. Click File > Add/Insert BusElement to add three signal elements: signal1,
signal2, and signal3. For more information, see “Create and Specify Simulink.Bus Objects”.
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5. Save the bus objects in your current folder as ex_signal_struct_data.mat.

This bus object represents the structure type that you want the generated code to use.

6. In the Bus Creator block dialog box, set Output data type to Bus: my_signals_type.

7. Select Output as nonvirtual bus. Click OK. A nonvirtual bus appears in the generated code as a
structure.

8. Open the Simulink Coder app. In the C Code tab, select Code Interface > Individual Element
Code Mappings.

9. Open the Signals/States tab. In the model, select the output signal of the Bus Creator block and
click the Add selected signals to code mappings button in the Code Mappings editor.

11. For the added signal, set Storage Class to ExportedGlobal.

12. In the Property Inspector, set the Code > Identifier property to sig_struct_var. The output of
the Bus Creator block appears in the generated code as a separate global structure variable named
sig_struct_var.

13. Generate code from the model.

Results

The generated header file ex_signal_struct_types.h defines the structure type
my_signals_type.

typedef struct {
  real_T signal1;
  real_T signal2;
  real_T signal3;
} my_signals_type;

The source file ex_signal_struct.c allocates memory for the global variable sig_struct_var,
which represents the output of the Bus Creator block.

/* Exported block signals */
my_signals_type sig_struct_var;        /* '<Root>/Bus Creator' */

In the same file, in the model step function, the algorithm accesses sig_struct_var and the fields
of sig_struct_var.

See Also
Simulink.Bus

Related Examples
• “Organize Data into Structures in Generated Code” on page 34-145
• “Group Nonvirtual Buses in Arrays of Buses”
• “Configure Signal Data for C Code Generation” on page 33-51
• “C Code Generation Configuration for Model Interface Elements” on page 33-2

 Structures of Signals

25-63



Nested Structures of Signals
You can create nested structures of signal data in the generated code.

C Construct

typedef struct {
  double signal1;
  double signal2;
  double signal3;
} B_struct_type;

typedef struct {
  double signal1;
  double signal2;
} C_struct_type;

typedef struct {
  B_struct_type subStruct_B;
  C_struct_type subStruct_C;
} A_struct_type;

Procedure

To represent a structure type in a model, create a Simulink.Bus object. Use the object as the data
type of bus signals in your model.

To nest a structure inside another structure, use a bus object as the data type of a signal element in
another bus object.

1. Create the ex_signal_nested_struct model with Gain blocks, Bus Creator blocks, and a Unit
Delay block. The Gain and Unit Delay blocks make the structure more identifiable in the generated
code.
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2. To configure a Bus Creator block to accept three inputs, in the block dialog box, set Number of
inputs to 3.

3. In the toolstrip, on the Modeling tab, under Design, click Bus Editor.

In the Bus Editor, click File > Add Bus to create a Simulink.Bus object and name it
A_struct_type. Click File > Add/Insert BusElement to add two signal elements: subStruct_B
and subStruct_C. For more information, see “Create and Specify Simulink.Bus Objects”. This bus
object represents the top-level structure type that you want the generated code to use.

4. Similarly, create Simulink.Bus objects B_struct_type (with three signal elements) and
C_struct_type (with two signal elements).

5. In A_struct_type object, for the subStruct_B element, set DataType to Bus:
B_struct_type and subStruct_C to Bus: C_struct_type.

Each signal element in A_struct_type uses another bus object as a data type. Now, these elements
represent substructures.
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6. In the dialog box of the Bus Creator block that collects the three Gain signals, set Output data
type to Bus: B_struct_type. Click Apply.

7. Select Output as nonvirtual bus and click OK.

8. In the dialog box of the other subordinate Bus Creator block, set Output data type to Bus:
C_struct_type and select Output as nonvirtual bus. Click OK.

9. In the last Bus Creator block dialog box, set Output data type to Bus: A_struct_type and
select Output as nonvirtual bus. Click OK.

10. Open the Simulink Coder app. In the C Code tab, select Code Interface > Individual
Element Code Mappings.

11. Open the Signals/States tab. In the model, select the output signal of the A_struct_type Bus
Creator block, which feeds the Unit Delay block. Click the Add selected signals to code mappings
button in the Code Mappings editor.

12. For the added signal, set Storage Class to ExportedGlobal.

13. In the Property Inspector, set the Code > Identifier property to sig_struct_var. The output of
the Bus Creator block appears in the generated code as a separate global structure variable named
sig_struct_var.

14. Generate code from the model.

Results

The generated header file ex_signal_nested_struct_types.h defines the structure types. Each
structure type corresponds to a Simulink.Bus object.

typedef struct {
  real_T signal1;
  real_T signal2;
  real_T signal3;
} B_struct_type;

typedef struct {
  real_T signal1;
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  real_T signal2;
} C_struct_type;

typedef struct {
  B_struct_type subStruct_B;
  C_struct_type subStruct_C;
} A_struct_type;

The generated source file ex_signal_nested_struct.c allocates memory for the global structure
variable sig_struct_var. By default, the name of the A_struct_type Bus Creator block is Bus
Creator2.

/* Exported block signals */
A_struct_type sig_struct_var;          /* '<Root>/Bus Creator2' */

In the same file, in the model step function, the algorithm accesses sig_struct_var and the fields
of sig_struct_var.

See Also
Simulink.Bus

Related Examples
• “Organize Data into Structures in Generated Code” on page 34-145
• “Group Nonvirtual Buses in Arrays of Buses”
• “Configure Signal Data for C Code Generation” on page 33-51
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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Bitfields
C Construct

typedef struct {
   unsigned int p1 : 1;
   unsigned int p2 : 1;
   unsigned int p3 : 1;
} my_struct_type

Procedure

1. Open example model ex_struct_bitfield_CSC. The model contains three Constant blocks and
three Outport blocks.

2. Open the Model Data Editor. On the Modeling tab, click Model Data Editor.

3. In the Model Data Editor, on the Parameters tab, in the Value column, observe that the value of
the first Constant block is p1. Next to the parameter value, click the action button (the button with
three vertical dots) and select Create.

4. In the Create New Data dialog box, set Value to Simulink.Parameter(false). Click Create. A
Simulink.Parameter object, p1, appears in the base workspace. The object stores a Boolean value,
false, and uses the data type boolean.

5. In the Simulink.Parameter property dialog box, click OK.

6. Use the Model Data Editor to configure the other Constant blocks to refer to new parameter
objects named p2 and p3.

7. Open the Embedded Coder app.

8. In the C Code tab, select Code Interface > Individual Element Code Mappings.

9. In the Code Mappings editor, on the Parameters tab, click the Update Code Mappings button.

10. Use the Storage Class column to apply the storage class BitField to all parameter objects.

10. In the Property Inspector, sse the Struct Name column to configure each object to use the same
structure type, my_struct.

11. Generate code from the model.
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Results

The generated header file ex_struct_bitfield_CSC.h defines the structure type
my_struct_type.

/* Type definition for custom storage class: BitField */
typedef struct myStruct_tag {
  uint_T p1 : 1;                       /* Referenced by: '<Root>/Constant1' */
  uint_T p2 : 1;                       /* Referenced by: '<Root>/Constant2' */
  uint_T p3 : 1;                       /* Referenced by: '<Root>/Constant3' */
} myStruct_type;

The generated source file ex_struct_bitfield_CSC.c defines and initializes the structure
variable my_struct.

/* Definition for custom storage class: BitField */
myStruct_type myStruct = {
  /* p1 */
  0,

  /* p2 */
  0,

  /* p3 */
  0
};

See Also

Related Examples
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Pack Boolean data into bitfields”
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Arrays for Parameters
C Construct

float myParams[5]= {1.0F,2.0F,3.0F,4.0F,5.0F};

Procedure

1. Create the ex_param_array model by using a Gain block.

2. In the model, select the Gain block. In the Property Inspector, set the value of the Gain parameter
to myParam.

3. Next to the parameter value, click the action button (the button with three vertical dots) and select
Create.

4. In the Create New Data dialog box, set Value to Simulink.Parameter ([1 2 3 4 5]). Click
Create. A Simulink.Parameter object, myParam, appears in the base workspace. The Gain block
uses the object to set the value of the Gain parameter.

5. In the Simulink.Parameter property dialog box, set Storage class to ExportedGlobal. Click
OK.

With this setting, myParams appears in the generated code as a separate global variable.

6. Set Data type to single. Click OK.

7. To build the model and generate code, press Ctrl+B .

Results

The generated source file ex_param_array.c defines and initializes the global variable myParams.

/* Exported block parameters */
real32_T myParam[5] = { 1.0F, 2.0F, 3.0F, 4.0F, 5.0F } ;/* Variable: myParam
                                                         * Referenced by: '<Root>/Gain'
                                                         */

See Also

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Configure Parameters for C Code Generation” on page 33-62
• “Code Generation of Matrices and Arrays” on page 50-60
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Arrays for Signals
C Construct

double myIn[5];
double myOut[5];

Procedure

1. Open example model ex_signal_array.

2. In the Model Data Editor, select the Inports/Outports tab.

3. From the Change View drop-down list, select Design.

Observe these settings:

• For the Inport block, the Signal Name is myIn and Dimensions is [5 1].
• For the Outport block, the Signal Name is myOut.

4. Open the Embedded Coder app.

5. In the C Code tab, select Code Interface > Individual Element Code Mappings.

6. In the Code Mappings editor, on the Inports tab, for the Inport block and the Outport block, the
Storage Class is ExportedGlobal. With this setting, the blocks appear in the generated code as
separate global variables.

7. To build the model and generate code, press Ctrl+B .

Results

The generated source file ex_signal_array.c defines the global variables myIn and myOut as
arrays with 5 elements each.

/* Exported block signals */
real32_T myIn[5];                      /* '<Root>/In1' */
real32_T myOut[5];                     /* '<Root>/Out1' */

See Also

Related Examples
• “Determine Signal Dimensions”
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Configure Signal Data for C Code Generation” on page 33-51
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• “Code Generation of Matrices and Arrays” on page 50-60
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Pointers
When your handwritten code allocates memory for signal, state, or parameter data, you can generate
code that accesses that data through a pointer. Apply a storage class such as
ImportedExternPointer to a data item in the model. Your handwritten code provides the pointer
definition.

C Construct

extern double *myIn;

Procedure

1. Open example model ex_pointer.

2. Open the Embedded Coder app.

3. In the C Code tab, select Code Interface > Individual Element Code Mappings.

4. In the Code Mappings editor, on the Inports tab, set Storage Class for the Inport block to
ImportedExternPointer.

5. Generate code from the model.

Results

The generated header file ex_pointer.h declares the pointer.

/* Imported (extern) pointer block signals */
extern real_T *In1;                    /* '<Root>/In1' */

In the generated source file ex_pointer.c, in the model step function, the algorithm dereferences
the pointer, In1.

/* Model step function */
void ex_pointer_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtY.Out1 = *In1;
}

See Also

Related Examples
• “C Code Generation Configuration for Model Interface Elements”
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• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
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Variant Systems in Embedded Coder

• “Implement Dimension Variants for Array Sizes in Generated Code” on page 26-2
• “Code Generation for Variant Blocks” on page 26-15
• “Represent Subsystem and Variant Models in Generated Code” on page 26-21
• “Generate Preprocessor Conditionals for Variant Systems” on page 26-31
• “Represent Variant Source and Sink Blocks in Generated Code” on page 26-36
• “Configure Dimension Variants for S-Function Blocks” on page 26-44
• “Represent Variant Condition Values of Enumerated Type in Generated Code” on page 26-51
• “Options to Represent Variant Parameters in Generated Code” on page 26-55
• “Generate Code for Variant Subsystem with Child Subsystems of Different Output Signal

Dimensions” on page 26-60
• “Use Variant Subsystem To Generate Code That Uses C Preprocessor Conditionals”

on page 26-63
• “Use Variant Models to Generate Code That Uses C Preprocessor Conditionals” on page 26-68
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Implement Dimension Variants for Array Sizes in Generated
Code

Dimension Variants
Use symbolic dimensions to simulate various sets of dimension choices without regenerating code for
every set. Set up your model with dimensions that you specify as symbols in blocks and data objects.
These symbols propagate throughout the model during simulation, and then go into the generated
code. Modeling constraints for symbols during simulation (for example, C=A+B) are output as
preprocessor conditionals in either the model.h or the model _types.h file.

You can directly specify dimension information as a symbol or a numeric constant for these blocks
and data objects:

• Inport
• Outport
• Signal Specification
• Data Store Memory
• Interpreted MATLAB Function
• Simulink.Signal
• Simulink.Parameter
• Simulink.BusElement
• AUTOSAR.Parameter

The Data Store Memory and Interpreted MATLAB Function blocks also support variable dimension
signals. For these blocks, the symbolic dimensions control the maximum allowed size.

You must provide the initialization code for Simulink.Parameter objects that contain symbolic
dimensions. To prevent the generated code from initializing these parameters, you must either:

• Configure the parameters to use a storage class with the Data scope property set to Imported,
such as the ImportedExtern or ImportedExternPointer built-in storage classes.

• Configure the parameters to use a storage class with the Data initialization property set to
None.

You use Simulink.Parameter objects to specify dimension information as symbols. For more
information on signal dimensions, see “Determine Signal Dimensions”.

You must fix symbolic dimension values at compile-time. You can not resolve a symbolic dimension to
another variable and then vary it during run-time because you define the behavior during simulation.

Note: The dimension variants feature is on by default. You can turn off this feature by clearing the
“Allow symbolic dimension specification” parameter in the Configuration Parameters dialog box.

Define Symbolic Dimensions

This example uses the model rtwdemo_dimension_variants to show how to implement symbolic
dimensions. This model has four modeling patterns involving vectors and matrices.
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1 To show block names, on the Debug tab, on the Information Overlays menu, clear the Hide
Automatic Block Names parameter.

2 Open the Embedded Coder app. In the C Code tab, select Code Interface > Individual
Element Code Mappings.

3 In the Code Mappings editor, on the Parameters tab, click the refresh button. Seven
Simulink.Parameter objects appear. Four of these objects are for specifying symbolic
dimensions. These Simulink.Parameter objects have the names A, B, C, and D. Notice that
these parameters have a storage class of CompilerFlag.

To use a Simulink.Parameter object for dimension specification, it must be defined in the base
workspace and have one of these storage classes:

• Define or ImportedDefine with header file specified
• CompilerFlag
• User-defined custom storage class that defines data as a macro in a specified header file

For Simulink.Parameter objects with an ImportedDefine custom storage class, provide a header
file on the MATLAB path. Insert the name of the header file in the HeaderFile field in the
Simulink.Parameter dialog box.

You can use MATLAB expressions to specify symbolic dimensions. For a list of supported MATLAB
expressions, see the section Operators and Operands in Variant Condition Expressions in
“Introduction to Variant Controls”.
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Specify Symbolic Dimensions for Blocks and Data Objects

1 Click Inport Block In2. On the Property Inspector, on the Parameters tab, the Port Dimensions
field contains the Simulink.Parameter object A. For Inport blocks, you specify symbolic
dimensions in the Port Dimensions field.

2 Click Inport block In3. The Port Dimensions field contains the Simulink.Parameter object B.
3 Click the Constant block. The Constant value parameter has a value of Data. In the Code

Mappings editor, on the Parameters tab, click the Simulink.Parameter object Data. On the
Property Inspector, the Dimension field has the character vector '[1,C]' , which is equivalent
to '[1,5]' because C has a value of 5. The Value field contains an array with 5 values, which is
consistent with its dimensions. The dimensions of the data object must be consistent with the
value of the Simulink.Parameter object that is in the Dimensions field. Notice that Data has
a Storage class of ImportedExtern.

4 Open the 1-D Lookup Table1 block parameters dialog box. The Table data field contains the
Simulink.Parameter, PT. The Breakpoints 1 field contains the Simulink.Parameter, PB.

5 In the Code Mappings editor, click PB and PT and view their properties. These parameters
contain the character vector '[1,D]' in their Dimensions field and are arrays consisting of 15
values. The value of D is consistent with the dimension of the PB and PT parameters because D
has a value of 15 .

6 Simulate the model. Simulink propagates the dimensions symbolically in the diagram. During
propagation, Simulink establishes modeling constraints among symbols. Simulink then checks for
consistency with these constraints based on current numerical assignments. One modeling
constraint for rtwdemo_dimension_variants is that C=A+B. The Diagnostic Viewer
produces a warning for any violations of constraints.

7 Change the dimension specification to a different configuration and simulate the model again.
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Though not shown in this example, you can specify an n-D dimension expression with one or more of
the dimensions being a symbol (for example, '[A,B,C]' or '[1,A,3]').

Generate Code for a Model with Dimension Variants

Once you have verified dimension specifications through model simulation, generate code for
rtwdemo_dimension_variants.

Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

model='rtwdemo_dimension_variants';
slbuild(model)

### Starting build procedure for: rtwdemo_dimension_variants
### Successful completion of build procedure for: rtwdemo_dimension_variants

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
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rtwdemo_dimension_variants  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 23.002s

View the generated code. In the rtwdemo_dimension_variants.h file, symbolic dimensions are in
data declarations.

hfile = fullfile(cgDir,'rtwdemo_dimension_variants_ert_rtw',...
    'rtwdemo_dimension_variants.h');
rtwdemodbtype(hfile,'/* External inputs', '/* Real-time', 1, 0);

/* External inputs (root inport signals with default storage) */
typedef struct {
  real_T In2[A];                       /* '<Root>/In2' */
  real_T In3[B];                       /* '<Root>/In3' */
} ExtU;

/* External outputs (root outports fed by signals with default storage) */
typedef struct {
  real_T Out1[(A + B)];                /* '<Root>/Out1' */
  real_T Out2[(A + B)];                /* '<Root>/Out2' */
} ExtY;

The rtwdemo_dimension_variants.h file contains data definitions and preprocessor conditionals
that define constraints established among the symbols during simulation. One of these constraints is
that the value of a symbolic dimension must be greater than 1. This file also includes the user-
provided header file for any Simulink.Parameter objects with an ImportedDefine custom
storage class.

hfile = fullfile(cgDir,'rtwdemo_dimension_variants_ert_rtw',...
    'rtwdemo_dimension_variants.h');
rtwdemodbtype(hfile,'#ifndef A', '/* Macros for accessing', 1, 0);

#ifndef A
#error The variable for the parameter "A" is not defined
#endif

#ifndef B
#error The variable for the parameter "B" is not defined
#endif

#ifndef C
#error The variable for the parameter "C" is not defined
#endif

#ifndef D
#error The variable for the parameter "D" is not defined
#endif

/*
 * Constraints for division operations in dimension variants
 */
#if (1 == 0) || (((A+B) % 1) != 0)
# error "The preprocessor definition '1' must not be equal to zero and     the division of '(A+B)' by '1' must not have a remainder."
#endif

/*
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 * Registered constraints for dimension variants
 */
/* Constraint 'C == (A+B)' registered by:
 * '<Root>/1-D Lookup Table1'
 */
#if C != (A+B)
# error "The preprocessor definition 'C' must be equal to '(A+B)'"
#endif

#if A <= 1
# error "The preprocessor definition 'A' must be greater than '1'"
#endif

#if B <= 1
# error "The preprocessor definition 'B' must be greater than '1'"
#endif

/* Constraint 'D > 1' registered by:
 * '<Root>/1-D Lookup Table1'
 */
#if D <= 1
# error "The preprocessor definition 'D' must be greater than '1'"
#endif

/* Constraint 'C > 1' registered by:
 * '<S2>/Assignment'
 */
#if C <= 1
# error "The preprocessor definition 'C' must be greater than '1'"
#endif

#if A >= 11
# error "The preprocessor definition 'A' must be less than '11'"
#endif

#if B >= 11
# error "The preprocessor definition 'B' must be less than '11'"
#endif

/* Constraint 'D < 21' registered by:
 * '<Root>/1-D Lookup Table1'
 */
#if D >= 21
# error "The preprocessor definition 'D' must be less than '21'"
#endif

/* Constraint 'C < 11' registered by:
 * '<S2>/Assignment'
 */
#if C >= 11
# error "The preprocessor definition 'C' must be less than '11'"
#endif

In the rtwdemo_dimension_variants.c file, symbolic dimensions participate in loop bound
calculations, array size and index offset calculations, and a parameterized utility function (for
example, Lookup Table block) calculation.
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cfile = fullfile(cgDir,'rtwdemo_dimension_variants_ert_rtw',...
    'rtwdemo_dimension_variants.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_dimension_variants_step(void)
{
  real_T rtb_VectorConcatenate[A + B];
  real_T rtb_VectorConcatenate_m;
  int32_T ForEach_itr;
  int32_T i;
  int32_T s2_iter;

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In2'
   */
  for (ForEach_itr = 0; ForEach_itr <= (int32_T)(A - 1); ForEach_itr++) {
    rtb_VectorConcatenate[ForEach_itr] = 2.0 * rtU.In2[ForEach_itr];
  }

  /* End of Gain: '<Root>/Gain' */

  /* Gain: '<Root>/Gain1' incorporates:
   *  Inport: '<Root>/In3'
   */
  for (ForEach_itr = 0; ForEach_itr <= (int32_T)(B - 1); ForEach_itr++) {
    rtb_VectorConcatenate[(int32_T)(A + ForEach_itr)] = 3.0 *
      rtU.In3[ForEach_itr];
  }

  /* End of Gain: '<Root>/Gain1' */

  /* Outputs for Iterator SubSystem: '<Root>/For Each Subsystem' incorporates:
   *  ForEach: '<S1>/For Each'
   */
  for (ForEach_itr = 0; ForEach_itr <= (int32_T)((int32_T)(A + B) - 1);
       ForEach_itr++) {
    /* Sum: '<Root>/Add' incorporates:
     *  Constant: '<Root>/Constant'
     *  Lookup_n-D: '<Root>/1-D Lookup Table1'
     */
    rtb_VectorConcatenate_m = rtb_VectorConcatenate[ForEach_itr] + look1_binlx
      (Data[ForEach_itr], PB, PT, (uint32_T)((uint32_T)D - 1U));

    /* ForEachSliceAssignment generated from: '<S1>/Out1' incorporates:
     *  MATLAB Function: '<S1>/MATLAB Function'
     */
    /* MATLAB Function 'For Each Subsystem/MATLAB Function': '<S3>:1' */
    /* '<S3>:1:4' y = 2*u; */
    rtY.Out1[ForEach_itr] = 2.0 * rtb_VectorConcatenate_m;

    /* Sum: '<Root>/Add' */
    rtb_VectorConcatenate[ForEach_itr] = rtb_VectorConcatenate_m;
  }

  /* End of Outputs for SubSystem: '<Root>/For Each Subsystem' */

  /* Outputs for Iterator SubSystem: '<Root>/For Iterator Subsystem' incorporates:
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   *  ForIterator: '<S2>/For Iterator'
   */
  /* Constant: '<Root>/Constant1' */
  ForEach_itr = ((int32_T)A);
  if (((int32_T)A) < 0) {
    ForEach_itr = 0;
  }

  /* End of Constant: '<Root>/Constant1' */
  for (s2_iter = 0; s2_iter < ForEach_itr; s2_iter++) {
    /* Assignment: '<S2>/Assignment' incorporates:
     *  Constant: '<S2>/Constant'
     *  Outport: '<Root>/Out2'
     *  Product: '<S2>/Product'
     *  Selector: '<S2>/Selector'
     */
    if (s2_iter == 0) {
      for (i = 0; i <= (int32_T)((int32_T)(A + B) - 1); i++) {
        rtY.Out2[i] = rtb_VectorConcatenate[i];
      }
    }

    rtY.Out2[s2_iter] = rtb_VectorConcatenate[s2_iter] * 2.0;

    /* End of Assignment: '<S2>/Assignment' */
  }

  /* End of Outputs for SubSystem: '<Root>/For Iterator Subsystem' */
}

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Set Parameter Value Based on Variant Choice
When you specify the dimensions of a parameter in a model by using a symbol, you must make sure
that the parameter value is consistent with the dimension value. To simulate different choices for the
dimension value, you must manually correct the parameter value.

For example, in the rtwdemo_dimension_variants model , the Simulink.Parameter object
Data stores a vector value, [1 2 3 4 5], and uses a symbolic dimension C with initial value 5. If
you change the value of C, to simulate the model, you must make sure the number of elements in the
vector value matches the new value of C.

To reduce the effort of maintenance when you change the value of C, you can set the value of Data to
an expression involving C.

1 Open the model.

rtwdemo_dimension_variants
2 At the command prompt, inspect the initial values of Data and C. The value of Data is a vector of

integers from 1 to C.

Data.Value
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ans =

     1     2     3     4     5

C.Value

ans =

     5
3 In MATLAB code syntax, the value of Data is 1:C. To preserve this relationship between the

parameter objects, set the value of Data by using the slexpr function.

Data.Value = slexpr('1:C');
4 To prevent data type propagation errors, set the data type of Data explicitly to double, which is

the data type that the parameter acquired before you set the parameter value to an expression.

Data.DataType = 'double';
5 Set the value of C to a different number, such as 6. Due to dimension constraints in the model,

you must set the value of another dimension symbol, A, to 3.

C.Value = 6;
A.Value = 3;

6 Simulate the model. The block diagram shows that the value of Data now has six elements.

For more complicated applications, you can write your own MATLAB function that returns parameter
values based on dimension symbols. Set the value of the parameter data to an expression that calls
your function.

For general information about using an expression to set the value of a Simulink.Parameter
object, see “Set Variable Value by Using a Mathematical Expression”.

Code Generation Optimization Considerations
When you create a model with symbolic dimensions, be aware of the following optimization
considerations:

• The code generator reuses buffers only if dimension propagation establishes equivalence among
buffers.

26 Variant Systems in Embedded Coder

26-10



• Two loops with symbolic loop bound calculations are fused together only if they share equivalent
symbolic expression.

• Optimizations do not eliminate a symbolic expression or condition check based on the current
value of a symbolic dimension.

Backward Compatibility
If an existing model uses Simulink.Parameter objects to specify dimensions, it can be
incompatible with dimension variants. Here are two common scenarios:

• Only a subset of blocks accepts symbolic dimension specifications. If a block is not compatible
with symbolic dimensions, it causes an update diagram error.

• Simulink.Parameter objects that you use to define symbolic dimensions or have symbolic
dimensions must have one of the storage classes described in this example. If these specifications
are not met, the build procedure for the model fails during code generation.

You can address these backward compatibility issues by doing the following:

• Turn off dimension variants feature by clearing the Allow symbolic dimension specification
parameter in the Configuration Parameters dialog box.

• Update Simulink.Parameter objects that define symbolic dimensions or have symbolic
dimension specifications.

• Update the model so that only supported blocks have symbolic dimensions or propagate symbolic
dimensions.

Supported Blocks
For a list of supported blocks, see the Block Support Table. To access the information in this table,
enter showblockdatatypetable at the MATLAB command prompt. Unsupported blocks (for
example, MATLAB Function) can still work in a model containing symbolic dimensions as long as
these blocks do not directly interact with symbolic dimensions.

In the following cases, supported blocks do not propagate symbolic dimensions.

• For Assignment and Selector blocks, you set the Block Parameters > Index Option parameter
to Index vector (dialog). For Selector and Assignment blocks, if you specify a symbolic
dimension for the Index parameter, the code generator does not honor the symbolic dimension in
the generated code.

• For the Product block, you specify a value of 1 for the Block Parameters > Number of inputs
parameter, and you set the Multiply over parameter to Specified dimensions.

• For the ForEach block, you specify a symbolic dimension for the Partition Width parameter.

Note that the following modeling patterns are among those modeling patterns that can cause
Simulink to error out:

• For Switch blocks, an input signal or the Threshold parameter has symbolic dimensions, and you
select Allow different data input sizes (Results in variable-size output signal).

• A Data Store Read block selects elements of a Simulink.Bus signal that has symbolic
dimensions.

• For Lookup Table blocks, on the Block Parameters > Algorithm tab, you select the parameter
Use one input port for all input data.
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Limitations
The following products and software capabilities support dimension variants in that they act on the
numeric value of a symbolic dimension. These features do not support the propagation of symbolic
dimensions during model simulation and the preservation of symbolic dimensions in the generated
code.

• Code Replacement for Lookup Tables
• Software-in-the-Loop (SIL) and Processor-in-the-Loop (PIL) simulations
• Accelerator and rapid accelerator simulation modes
• Scope and simulation observation (for example, logging, SDI, and so on)
• Model coverage
• Simulink Design Verifier
• Fixed-Point Designer
• Data Dictionary
• Simulink PLC Coder
• HDL Coder

The following do not support dimension variants:

• System Object
• Stateflow charts that use MATLAB as the action language
• Physical modeling
• Discrete-event simulation
• Frame data
• MATLAB functions

The following limitations also apply to models that utilize symbolic dimensions.

• For simulation, the size of a symbolic dimension can equal 1. For code generation, the size of a
symbolic dimension must be greater than 1.

• If a symbolic dimension is a MATLAB expression that contains an arithmetic expression and either
a relational or logical expression, you must add +0 after the relational or logical part of the
MATLAB expression. If you do not add +0, the model errors out during simulation because you
cannot mix a boolean data type with integer or double data types. Adding +0 converts the data
type of the relational or logical part of the expression from a boolean to a double.

For example, suppose in the Inport block parameters dialog box, the Port dimensions parameter
has the expression [(C==8)*D+E,3]. The Data type parameter is set to double. Since C==8 is a
relational expression, you must change the expression to [((C==8)+0)*D+E,3] to prevent the
model from producing an error during simulation.

• Simulink propagates symbolic dimensions for an entire structure or matrix, but not for a part of a
structure or matrix. For example, the Simulink.Parameter P is a 2x3 matrix with symbolic
dimensions [Dim,Dim1].

p=Simulink.Parameter(struct('A',[1 2 3;4 5 6]))
p.DataType='Bus:bo'
bo=Simulink.Bus
bo.Elements(1).Name='A'
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bo.Elements(1).Dimensions='[Dim,Dim1]'
Dim=Simulink.Parameter(2)
Dim1=Simulink.Parameter(3)
p.CoderInfo.StorageClass='Custom'
p.CoderInfo.CustomStorageClass='Define'
Dim.CoderInfo.StorageClass='Custom'
Dim.CoderInfo.CustomStorageClass='Define'
Dim1.CoderInfo.StorageClass='Custom'
Dim1.CoderInfo.CustomStorageClass='Define'

If you specify p.A for a dimensions parameter, Simulink propagates the symbolic dimensions
[Dim,Dim1]. If you specify p.A(1,:), Simulink propagates the numeric dimension 3 but not the
symbolic dimension, Dim1.

• The MATLAB expression A(:) does not maintain symbolic dimension information. Use A instead.
• The MATLAB expression P(2:A) does not maintain symbolic dimension information. Use the

Selector block instead.
• The MATLAB expression P(2,:) is not a tunable expression, so it does not maintain symbolic

dimension information.
• Suppose that you set the value of a mask parameter, myMaskParam, by using a field of a structure

or by using a subset of the structures in an array of structures. You store the structure or array of
structures in a Simulink.Parameter object so that you can use a Simulink.Bus object to
apply symbolic dimensions to the structure fields. Under the mask, you configure a block
parameter to use one of the fields that have symbolic dimensions. The table shows some example
cases.

Description Value of mask parameter
(myMaskParam)

Value of block parameter

myStruct is a structure with
field gains, which uses
symbolic dimensions.

myStruct.gains myMaskParam

myStruct is a structure with
field hierarchy
myStruct.subStruct.gain
s. The field gains uses
symbolic dimensions.

myStruct.subStruct myMaskParam.gains

myStructs is an array of
structures. Each structure has
a field gains, which uses
symbolic dimensions.

myStructs(2) myMaskParam.gains

In these cases, you cannot generate code from the model. As a workaround, choose one of these
techniques:

• Use the entire structure (myStruct) or array of structures (myStructs) as the value of the
mask parameter. Under the mask, configure the block parameter to dereference the target
field from the mask parameter by using an expression such as
myMaskParam.subStruct.gains.

• Use literal dimensions instead of symbolic dimensions for the target field (gains).

This limitation also applies when you use a field of a structure or a subset of the structures in an
array of structures as the value of a model argument in a Model block.
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See Also

Related Examples
• “Configure Dimension Variants for S-Function Blocks” on page 26-44
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Code Generation for Variant Blocks
The code generator produces code from a Simulink model containing one or more Variant Subsystem,
Variant Source, and Variant Sink blocks. To learn how to create a model containing variant blocks,
see “Create a Simple Variant Model”. To learn how to create a custom Model Advisor check that
evaluates the generated code from active and inactive variant paths in a variant system model, see
“Create Custom Check to Evaluate Active and Inactive Variant Paths from a Model” (Simulink Check).

Note During code generation, a warning related to 'Code generation function packaging' for the
Variant block might be displayed. In the block parameters dialog of the Variant block, click Code
Generation and then select Reusable function from the Function packaging drop-down list to
solve this issue.

Code is generated for different variant choices, the active variant, and the default variant. To
generate code for variants, set the following conditions in the Variant Subsystem, Variant Source, or
Variant Sink block:

• Select Expression as Variant control mode.
• Select code compile as Variant activation time.

Code generated for Variant Subsystem blocks is surrounded by C preprocessor conditionals #if,
#else, #elif, and #endif. Code generated for Variant Source and Variant Sink blocks is
surrounded by C preprocessor conditionals #if and #endif. Therefore, the active variant is selected
at compile time and the preprocessor conditionals determine which sections of the code to execute.

To construct variant models and generate preprocessor directives in the generated code, see the
example “Use Variant Models to Generate Code That Uses C Preprocessor Conditionals” on page 26-
68.

To construct variant subsystems and generate preprocessor directives in the generated code, see the
example “Use Variant Subsystem To Generate Code That Uses C Preprocessor Conditionals” on page
26-63.

To construct models with variant sources and sinks and generate preprocessor directives in the
generated code, see the example “Represent Variant Source and Sink Blocks in Generated Code” on
page 26-36.

Restrictions on Variant Subsystem Code Generation
To generate preprocessor conditionals, the types of blocks that you can place within the child
subsystems of a Variant Subsystem block are limited. Connections are not allowed in the Variant
Subsystem block diagram. However, during the code generation process, one VariantMerge block is
placed at the input of each Outport block within the Variant Subsystem block diagram. All of the child
subsystems connect to each of the VariantMerge blocks.

In the figure below, the code generation process makes the following connections and adds
VariantMerge blocks to the sldemo_variant_subsystems model.

When compared to a generic Merge block the VariantMerge block can have only one parameter
which is the number of Inputs. The VariantMerge block is used for code generation in variant
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subsystems internally, and is not available externally to be used in models. The number of inputs for
VariantMerge is determined and wired as shown in the figure below.

The child subsystems of the Variant Subsystem block must be atomic subsystems. Select Treat as
atomic unit parameter in the Subsystem block parameters dialog, to make the subsystems atomic.
The VariantMerge blocks are inserted at the outport of the subsystems if more than one child
subsystems are present. If the source block of a VariantMerge block input is nonvirtual, an error
message will be displayed during code generation. You must make the source block contiguous, by
inserting Signal Conversion blocks inside the variant choices. The signals that enter a Variant
Subsystem block must have the same signal properties (for example, signal dimensions, port width,
and storage class). The VariantMerge block does not support different signal properties because
the input ports and output ports share the same memory. You can use symbolic dimensions to
generate code for a variant subsystem with child subsystems of different output signal dimensions.

Generated Code Components Not Compiled Conditionally
The following components are not conditionally compiled even if only code for variant subsystems or
models that are conditionally compiled reference them.

• rtModel data structure fields
• #include's of utility files
• Global constant parameter structure fields that are referenced by multiple subsystems activated

by different variants
• Parameters that are configured to use an imported, exported, or custom code generation storage

class, and are referenced by multiple subsystems that are activated by different variants
• Parameters that are configured to use an imported, exported, or custom code generation storage

class, and are used by variant model blocks
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Code Generation for Variant Blocks with One Variant Choice
For modeling patterns in which a Root Inport block connects to a Variant block with one variant
choice, Simulink inserts a hidden block combination of a Ground block, Signal Conversion block, and
a Variant Merge block. If the variant choice evaluates to false, this block combination produces an
output of 0.0.

For example, the model Varianttoground contains a Variant Source block with one variant choice.
When the Variant Control SYSCONST_A==6 evaluates to true, the input to Subsystem is a sine wave.
When SYSCONST_A==6 evaluates to false, the input to Subsystem is 0.0.

The varianttoground.c file contains this code:

* Sin: '<Root>/Sine Wave' incorporates:
   *  SignalConversion generated from: '<Root>/Subsystem'
   */
#if SYSCONST_A == 6

  Varianttoground_B.VM_Conditional_Signal_Subsystem_0 = sin
    (Varianttoground_M->Timing.t[0]);

#else

  /* SignalConversion generated from: '<Root>/Subsystem' */
  Varianttoground_B.VM_Conditional_Signal_Subsystem_0 = 0.0;

#endif

  /* End of Sin: '<Root>/Sine Wave' */

The comments in the generated code indicate the presence of the hidden signal conversion block. In
the hyperlinked comments, you can trace to the original block in the model that triggered the
insertion of the hidden block. The code does not contain a comment for the Variant Merge block
because this block does not have associated generated code. The Variant Merge block is used
internally and is not in the Simulink library.
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Global Data Guarding: Signals and States
When a model has variant blocks, the global signals and states are guarded in the generated code
with their corresponding variant condition.

Consider a model containing a Variant Source block. The Variant Source block has conditions V==1
and V==2.

In the generated code, global signals are guarded in declaration, model initialization, and definition
of data as shown below.

Signals guarding:

Declaration:

/* Exported block signals */
#if V == 1 || V == 2

real_T myOutput;                       /* '<Root>/Gain3' */

#endif

Model initialization:

  /* exported global signals */
#if V == 1 || V == 2

  myOutput = 0.0;

#endif
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Definition of data:

 * Exported Global Signals
 *
 * Note: Exported global signals are block signals with an exported global
 * storage class designation.  Code generation will declare the memory for
 * these signals and export their symbols.
 *
 */
#if V == 1 || V == 2

extern real_T myOutput;                /* '<Root>/Gain3' */

#endif

Global Data Guarding: Parameters
When you generate code for a model containing variant blocks, the parameters are guarded in the
generated code.

Consider a model with Constant block attached to a Variant Source block.

In the generated code, the parameter of the Constant block is guarded in header file as shown below.

/* Exported data definition */
/* Const memory section */
/* Definition for custom storage class: Const */
#if V == 2

const int32_T Parameter2 = 1;

#endif

Guarding Reference Model Headers
When a model has Model Reference blocks that are conditional due to inline variants, the header file
and the instances referring to the Model Reference blocks are guarded.

Consider this model with two Model References blocks that are conditional due to inline variants.
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When you generate code for this model, the header file and instances referring to the Model
Reference blocks are guarded as shown in the code below.

#include "mWithTwoModelBlocks_Top_types.h"
#include "multiword_types.h"

#if (A == 1) //Guarding 
#define mWithTwoModelBlocks_Ref2_MDLREF_HIDE_CHILD_
#include "mWithTwoModelBlocks_Ref2.h"
#endif

#if (B == 1) //Guarding
#include "mWithTwoModelBlocks_Ref1.h"
#endif
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Represent Subsystem and Variant Models in Generated Code
In this section...
“Step 1: Represent Variant Choices in Simulink” on page 26-21
“Step 2: Specify Conditions That Control Variant Choice Selection” on page 26-24
“Step 3: Configure Model for Generating Preprocessor Conditionals” on page 26-26
“Step 4: Review Generated Code” on page 26-27
“Limitations” on page 26-30

Required products: Simulink, Embedded Coder, Simulink Coder

Using Simulink, you can create models that are based on a modular design platform that comprises a
fixed common structure with a finite set of variable components. The variability helps you develop a
single, fixed master design with variable components. For more information, see “What Are Variants
and When to Use Them”. When you implement variants in the generated code, you can:

• Reuse generated code from a set of application models that share functionality with minor
variations.

• Share generated code with a third party that activates one of the variants in the code.
• Validate the supported variants for a model and then choose to activate one variant for a

particular application, without regenerating and re-validating the code.
• Generate code for the default variant that is selected when an active variant does not exist.

Using Embedded Coder, you can generate code from Simulink models containing one or more variant
choices. The generated code contains preprocessor conditionals that control the activation of each
variant choice.

This example shows how to represent variant choices in a Simulink model and then prepare the
model so that those variant choices are represented in generated code.

Step 1: Represent Variant Choices in Simulink
Variant choices are two or more configurations of a component in your model. This example uses the
model rtwdemo_preprocessor_subsys to illustrate how to represent variant choices inside
Variant Subsystem blocks. For other ways to represent variant choices, see “Options for Representing
Variants in Simulink”.

1 Open the model rtwdemo_preprocessor_subsys.

open_system('rtwdemo_preprocessor_subsys')
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The model contains two Variant Subsystem blocks: LeftController and RightController.

Note You can only add Inport, Outport, Subsystem, and Model blocks inside a Variant Subsystem
block.

2 Open the LeftController block.
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The LeftController block serves as the container for the variant choices. It contains two variant
choices represented using Subsystem blocks Nonlinear and Linear. The nonlinear controller
subsystems implement hysteresis, whereas the linear controller subsystems act as simple low-
pass filters.

The Subsystem blocks have the same number of inports and outports as the containing Variant
Subsystem block.

Variant choices can have different numbers of inports and outports. See “Mapping Inports and
Outports of Variant Choices”.

3 Open the Nonlinear block.
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The Nonlinear block represents one variant choice that Simulink activates when a condition is
satisfied. The Linear block represents another variant choice.

Tip When you are prototyping variant choices, you can create empty Subsystem blocks with no
inputs or outputs inside a Variant Subsystem block. The empty subsystem recreates the situation
in which that subsystem is inactive without the need for completely modeling the variant choice.

Step 2: Specify Conditions That Control Variant Choice Selection
You can switch between variant choices by constructing conditional expressions called variant
controls for each variant choice represented in a Variant Subsystem block. Variant controls determine
which variant choice is active, and changing the value of a variant control causes the active variant
choice to switch.

A variant control is a Boolean expression that activates a specific variant choice when it evaluates to
true.

For more information, see “Introduction to Variant Controls”.

1 Right-click the LeftController block and select Block Parameters (Subsystem).
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The Condition column displays the Boolean expression that when true activates each variant
choice. In this example, these conditions are specified using Simulink.Variant objects
LINEAR and NONLINEAR.

2 Use these commands to specify a variant control using a Simulink.Variant object.

LINEAR = Simulink.Variant;
LINEAR.Condition = 'VSSMODE==0';
NONLINEAR = Simulink.Variant;
NONLINEAR.Condition = 'VSSMODE==1';

Here, VSSMODE is called a variant control variable that can be specified in one of the ways listed
in “Approaches for Specifying Variant Controls”.

3 Define the variant control variable VSSMODE.

You can define VSSMODE as a scalar variable or as a Simulink.Parameter object. In addition to
enabling the specification of parameter value, Simulink.Parameter objects allow you to
specify other attributes such as data type that are required for generating code.

VSSMODE = Simulink.Parameter;
VSSMODE.Value = 1;
VSSMODE.DataType = 'int32';
VSSMODE.CoderInfo.StorageClass = 'Custom';
VSSMODE.CoderInfo.CustomStorageClass = 'ImportedDefine';
VSSMODE.CoderInfo.CustomAttributes.HeaderFile = 'rtwdemo_importedmacros.h';

Variant control variables defined as Simulink.Parameter objects can have one of these
storage classes.
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• Define or ImportedDefine with header file specified
• CompilerFlag
• SystemConstant (AUTOSAR)
• Your own custom storage class that defines data as a macro

You can also convert a scalar variant control variable into a Simulink.Parameter object. See
“Convert Variant Control Variables into Simulink.Parameter Objects”.

Step 3: Configure Model for Generating Preprocessor Conditionals
Code generated for each variant choice is enclosed within C preprocessor conditionals #if, #else,
#elif, and #endif. Therefore, the active variant is selected at compile time and the preprocessor
conditionals determine which sections of the code to execute.

1 In the Modeling tab of the Simulink toolstrip, click Model Settings.
2 Select the Code Generation pane, and set System target file to ert.tlc.
3 In the Report pane, select Create code generation report.
4 In the Configuration Parameters dialog box, clear Ignore custom storage classes and click

Apply.
5 In your model, right-click the LeftController block and select Block Parameters (Subsystem).
6 Set the Variant activation time parameter to code compile.
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When you select this option, Simulink analyzes all variant choices during an update diagram or
simulation. This analysis provides early validation of the code generation readiness of all variant
choices.

7 Build the model.

Step 4: Review Generated Code
The code generation report contains a section dedicated to the subsystems that have variants
controlled by preprocessor conditionals.

1 In the C Code tab of the toolstrip, select Open Report.
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2 Select the Code Variant Report from the left.
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In this example, the generated code includes references to the Simulink.Variant objects
LINEAR and NONLINEAR. The code also includes the definitions of macros corresponding to those
variants. The definitions depend on the value of VSSMODE, which is supplied in an external
header file rtwdemo_importedmacros.h. The active variant is determined by using
preprocessor conditionals (#if) on the macros (#define) LINEAR and NONLINEAR.

3 Select the rtwdemo_preprocessor_subsys_types.h file from the left.

This file contains the definitions of macros LINEAR and NONLINEAR.

#ifndef LINEAR
    #define LINEAR      (VSSMODE == 0)
#endif

#ifndef NONLINEAR
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    #define NONLINEAR   (VSSMODE == 1)
#endif

4 Select the rtwdemo_preprocessor_subsys.c file from the left.

In this file, calls to the step and initialization functions of each variant are conditionally compiled.

    /* Outputs for Atomic SubSystem: '<Root>/LeftController' */
#if LINEAR
    /* Output and update for atomic system: '<S1>/Linear' */
    ...
#elif NONLINEAR
    /* Output and update for atomic system: '<S1>/Nonlinear' */
    ...
#endif

Limitations
• When you are generating code for Variant Subsystem blocks, the blocks cannot have:

• Mass matrices
• Function call ports
• Outports with constant sample time
• Simscape blocks

• The port numbers and names for each active child subsystem must belong to a subset of the port
numbers and names of the parent Variant Subsystem block.

See Also

Related Examples
• “Define, Configure, and Activate Variants”
• “Variant Subsystems”

More About
• “What Are Variants and When to Use Them”
• “Introduction to Variant Controls”
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Generate Preprocessor Conditionals for Variant Systems
In this section...
“Define Variant Controls” on page 26-31
“Configure Model for Generating Preprocessor Conditional Directives” on page 26-32
“Special Considerations for Generating Preprocessor Conditionals” on page 26-32
“Generate Variant Control Macros in Same Header File” on page 26-33

Define Variant Controls
For variant systems, conditional expressions called variant controls determine which variant choice is
active. You can specify a variant control as a condition expression, a Simulink.Variant object
specifying a condition expression, a MATLAB variable, or a Simulink.Parameter object. This
example shows how to define variant controls as Simulink.Parameter objects.

1 Open the Model Explorer. Select the base workspace.
2 In the Model Explorer, select Add > Simulink Parameter. Specify a name for the new

parameter.
3 Use the function Simulink.VariantManager.findVariantControlVars to find and convert

MATLAB variables used in variant control expressions into Simulink.Parameter objects. For
an example, see “Convert Variant Control Variables into Simulink.Parameter Objects”.

4 On the Simulink.Parameter property dialog box, specify the Value and Data type.
5 Select one of these Storage class values.

• Define
• ImportedDefine(Custom)
• CompilerFlag(Custom)
• A storage class created using the Custom Storage Class Designer. Your storage class must

have the Data initialization parameter set to Macro and the Data scope parameter set to
Imported. See “Control Data Representation by Configuring Storage Class Properties” on
page 38-18 for more information.

6 Specify the value of the variant control. If the storage class is ImportedDefine(Custom), do
the following:

a Specify the Header File parameter as an external header file in the Custom Attributes
section of the Simulink.Parameter property dialog box.

b Enter the values of the variant controls in the external header file.

Note The generated code refers to a variant control as a user-defined macro. The generated
code does not contain the value of the macro. The value of the variant control determines the
active variant in the compiled code.

If the variant control is a CompilerFlag custom storage class, the value of the variant
control is set at compile time. Use the Configuration Parameters > Code Generation >
Custom Code > Additional build information > Defines parameter to add a list of
variant controls (macro definitions) to the compiler command line. For example, for variant
control VSSMODE, in the text field for the Defines parameter, enter:
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-DVSSMODE=1

If you want to modify the value of the variant control after generating a makefile, use a
makefile option when compiling your code. For example, at a command line outside of
MATLAB, enter:

makecommand -f model.mk DEFINES_CUSTOM="-DVSSMODE=1"

Note You can define the variant controls using Simulink.Parameter object of enumerated type.
This approach provides meaningful names and improves the readability of the conditions. The
generated code includes preprocessor conditionals to check that the variant condition contains valid
values of the enumerated type.

Configure Model for Generating Preprocessor Conditional Directives
1 Open the Configuration Parameters dialog box.
2 Select the Code Generation pane, and set System target file as ert.tlc.
3 In the Report pane, select Create code generation report.
4 In the Configuration Parameters dialog box, clear the “Ignore custom storage classes” parameter.

In order to generate preprocessor conditionals, you must use custom storage classes.
5 In the Variant Subsystem, Variant Source, or Variant Sink block parameter dialog boxes, set the

Variant activation time parameter to code compile.
6 Generate code.

Special Considerations for Generating Preprocessor Conditionals
• The port numbers and names for each child variant subsystem must belong to a subset of the port

numbers and names of the parent Variant Subsystem block.
• The code generation process checks that there is at least one active variant by using the variant

control values stored in the base workspace. The variant control that evaluates to true becomes
the active variant. If none of the variant controls evaluates to true, the default variant, if
specified, becomes the active variant. The code generation process issues an error if an active
variant does not exist.

• Implement the condition expressions of the variant objects such that only one evaluates to true.
The generated code includes a test of the variant objects to determine that there is only one active
variant. If this test fails, your code will not compile.

• If you comment out child subsystems listed in the Variant Choices table in the Variant Subsystem
block parameter dialog box, the code generator does not generate code for the commented out
subsystems.

• If the sample time for a default variant differs from that of the other variant choices, the #else
preprocessor conditional is not generated for the default variant. Instead, an #if !(<variant
conditions>) is generated.

• For Variant Subsystems, the model_private.h file contains conditional parameter definitions.
For example, if the value of a Constant block is a Simulink.Parameter with an
ImportedDefine custom storage class, and the Constant block is in a Variant Subsystem, the
conditional definition of the Simulink.Parameter is in the model_private.h file.
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Generate Variant Control Macros in Same Header File
This example shows how to aggregate multiple variant control macros (#define) into the same
generated header file. This aggregation makes it easier for you to manage the complexities inherent
in a system with multiple interacting variant conditions.

Explore Example Model

Run the script prepare_rtwdemo_preproc_subsys, which opens the model
rtwdemo_preprocessor_subsys and prepares it for this example.

run(fullfile(matlabroot,'examples','ecoder','main','prepare_rtwdemo_preproc_subsys'));

The model contains two Variant Subsystem blocks.

Navigate inside the variant subsystems. The subsystems each have a linear and a nonlinear algorithm
variant.

At the root level of the model, open the block dialog box of the variant subsystem labeled
LeftController. The algorithm variants in the subsystem activate based on the states of two
Simulink.Variant objects, LINEAR and NONLINEAR, in the base workspace.

The state of each object depends on the values of two variant control variables, MODE_A and MODE_B,
which are Simulink.Parameter objects in the base workspace. The parameter objects use the
custom storage class Define and are configured to appear in the generated code as C-code macros
in macros.h.

Change Name of Generated Header File Through Model Data Editor

In this example, change the name of the generated header file from macros.h to
variant_controls.h. You must change the file name in each parameter object.

In the model, select Modeling > Model Data Editor.

In the Model Data Editor, select the Parameters tab.
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Click the Show/refresh additional information button.

Set the Change view drop-down list to Code.

In the Filter contents box, enter MODE. The Model Data Editor shows two rows that correspond to
the parameter objects.

Select both rows. Then, for one of the rows, use the Header File column to change the header file
name from macros.h to variant_controls.h. The Model Data Editor applies the change to both
rows.

Reduce Maintenance Effort by Creating Custom Storage Class

To change the name of the header file, you must change the configuration of each parameter object.
You can use the Model Data Editor to perform batch editing, but when you add a new variant control
variable (parameter object), you must remember to specify the name of the header file for that object.
Also, the Model Data Editor shows the parameter objects used by only one model at a time.

Instead, you can create a custom storage class and specify the name of the header file only once: In
the definition of the custom storage class.

Set your current folder to a writable location.

At the command prompt, copy the built-in SimulinkDemos package into your current folder as
myPackage.

copyfile(fullfile(matlabroot,...
    'toolbox','simulink','simdemos','dataclasses','+SimulinkDemos'),...
    '+myPackage','f')

Navigate inside the +myPackage folder to the file Parameter.m and open the file.

Uncomment the methods section that defines the method setupCoderInfo. In the call to the
function useLocalCustomStorageClasses, replace 'packageName' with 'myPackage'. When
you finish, the section appears as follows:

  methods
    function setupCoderInfo(h)
      % Use custom storage classes from this package
      useLocalCustomStorageClasses(h, 'myPackage');
    end
  end % methods

Save and close the file.

Set your current folder to the folder that contains the package myPackage.

Open the Custom Storage Class Designer.

cscdesigner('myPackage')

Select the custom storage class Define.

Click Copy. A new custom storage class, Define_1, appears. Select this new custom storage class.
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Set Name to VariantControlVar.

Set Header file to Specify. In the text box, enter variant_controls.h.

Click Apply, Save, and OK.

At the command prompt, replace the Simulink.Parameter objects MODE_A and MODE_B with
myPackage.Parameter objects. Apply the new custom storage class VariantControlVar.

MODE_A = myPackage.Parameter;
MODE_A.Value = 1;
MODE_A.DataType = 'int32';
MODE_A.CoderInfo.StorageClass = 'Custom';
MODE_A.CoderInfo.CustomStorageClass = 'VariantControlVar';

MODE_B = myPackage.Parameter;
MODE_B.Value = 1;
MODE_B.DataType = 'int32';
MODE_B.CoderInfo.StorageClass = 'Custom';
MODE_B.CoderInfo.CustomStorageClass = 'VariantControlVar';

Now, to indicate that a parameter object represents a variant control variable, you can apply the
custom storage class VariantControlVar. To change the name of the header file, use the Custom
Storage Class Designer.

See Also

Related Examples
• “Create Variant Controls Programmatically”
• “Working with Variant Choices”
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Represent Variant Source and Sink Blocks in Generated Code
In this section...
“Represent Variant Source and Variant Sink Blocks in Simulink” on page 26-36
“Specify Conditions That Control Variant Choice Selection” on page 26-39
“Review the Generated Code” on page 26-40
“Generate Code with Zero Active Variant Controls” on page 26-42

You can use Variant Source and Variant Sink blocks to perceive multiple implementations of a model
in a single, unified block diagram. Each implementation depends on conditions that you set for
Variant Source and Variant Sink blocks. Simulink propagates these conditions to upstream and
downstream blocks including root input and root output ports.

You can generate:

• Code from a Simulink model containing Variant Sink and Variant Source blocks.
• Code that contains preprocessor conditionals that control the activation of each variant choice.
• Preprocessor conditionals that allow for no active variant choice.

Represent Variant Source and Variant Sink Blocks in Simulink
This example shows how Variant Source blocks make model elements conditional.

1 From the Simulink Block Library, add 1 Sine Wave Function block, two Add blocks, three Gain
blocks, two Outports, and two Variant Source blocks into a new model.

2 Open the Sine Wave Function block. For the Sine type parameter, select Sample based. For the
Time (t) parameter, select Use simulation time. For the Sample time parameter, insert a
value of 0.2.

3 Make four copies of the Sine Wave Function block.
4 Connect and name the blocks as shown.
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5 Insert values of 2, 3, and 4 in the Gain2, Gain3, and Gain4 blocks, respectively.
6 Give the model the name inline_variants_example.
7 Open the Block Parameters dialog box for Variant Source.
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8 In the Variant control column, for Port 1, replace Choice_1 with V==1. For Port 2, replace
Choice_2 with V==2.

9 Open the Block Parameters dialog box for Variant Source1.
10 In the Variant control column, replace Choice_1 with W==1. For Port 2, replace Choice_2 with

W==2.
11 In the MATLAB Command Window, use these commands to define V and W as

Simulink.Parameter objects.

V = Simulink.Parameter;
V.Value = 1;
V.DataType='int32';
V.CoderInfo.StorageClass = 'custom';
V.CoderInfo.CustomStorageClass = 'Define';
V.CoderInfo.CustomAttributes.HeaderFile='inline_importedmacro.h'

W = Simulink.Parameter;
W.Value = 2;
W.DataType='int32';
W.CoderInfo.StorageClass = 'custom';
W.CoderInfo.CustomStorageClass = 'Define';
W.CoderInfo.CustomAttributes.HeaderFile='inline_importedmacro.h'

In this example, the variant control variables are Simulink.Parameter objects. For code
generation, if you use Simulink.Variant objects to specify variant controls, use
Simulink.Parameter objects or MATLAB variables to specify their conditions. .
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Variant control variables defined as Simulink.Parameter objects can have one of these
storage classes:

• Define with header file specified
• ImportedDefine with header file specified
• CompilerFlag
• SystemConstant (AUTOSAR)
• User-defined custom storage class that defines data as a macro in a specified header file

If you use scalar variant control variables to simulate the model, you can convert those variables
into Simulink.Parameter objects. See “Convert Variant Control Variables into
Simulink.Parameter Objects”.

12 Simulate the model.

Input port 1 is the active choice for Variant Source because the value of variant control
variable V is 1. Input port 2 is the active choice for Variant Source1 because the value of
variant control variable W is 2. The inactive choices are removed from execution, and their paths
are grayed-out in the diagram.

Specify Conditions That Control Variant Choice Selection
You can generate code in which each variant choice is enclosed within C preprocessor conditionals
#if and #endif. The compiler chooses the active variant at compile time and the preprocessor
conditionals determine which sections of the code to execute.

1 In the Modeling tab of the Simulink toolstrip, click Model Settings.
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2 On the Code Generation pane, and set System target file to ert.tlc.
3 On the Solver pane, set the Type parameter to Fixed-step.
4 In your model, open the block parameters dialog box for Variant Source.
5 Set the Variant activation time parameter to code compile. During an update diagram or

simulation, when you set this parameter value, Simulink analyzes all variant choices. This
analysis provides early validation of the code generation readiness of variant choices. During
code generation, when you set this parameter value, the code generator generates preprocessor
conditionals that control the activation of each variant choice.

6 Clear the Allow zero active variant controls parameter.
7 Open the Block Parameters dialog box for Variant Source 1. Repeat steps 5 through 7.
8 Build the model. When code generation is complete, the generated code is displayed in the Code

view.

Review the Generated Code
1 In the Code view, select the inline_variants_example.c file.
2 In the inline_variants_example.c file, the call to the inline_variants_example_step

function is conditionally compiled as shown:

/* Model step function */
void inline_variants_example_step(void)
{
  real_T rtb_VariantMerge_For_Variant_So;
  real_T rtb_VariantMerge_For_Variant__e;

  /* Sin: '<Root>/Sine2' incorporates:
   *  Sin: '<Root>/Sine3'
   *  Sum: '<Root>/Add'
   */
#if V == 2

  rtb_VariantMerge_For_Variant_So = sin((real_T)
    inline_variants_example_DW.counter * 2.0 * 3.1415926535897931 / 10.0) + sin
    ((real_T)inline_variants_example_DW.counter_g * 2.0 * 3.1415926535897931 /
     10.0);

#endif

  /* End of Sin: '<Root>/Sine2' */

  /* Sin: '<Root>/Sine4' incorporates:
   *  Sin: '<Root>/Sine5'
   *  Sum: '<Root>/Add1'
   */
#if W == 2

  rtb_VariantMerge_For_Variant__e = sin((real_T)
    inline_variants_example_DW.counter_c * 2.0 * 3.1415926535897931 / 10.0) +
    sin((real_T)inline_variants_example_DW.counter_i * 2.0 * 3.1415926535897931 /
        10.0);

#endif
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  /* End of Sin: '<Root>/Sine4' */

  /* Sin: '<Root>/Sine1' */
#if V == 1

  rtb_VariantMerge_For_Variant_So = sin((real_T)
    inline_variants_example_DW.counter_m * 2.0 * 3.1415926535897931 / 10.0);

#endif

  /* End of Sin: '<Root>/Sine1' */

  /* Outport: '<Root>/Outport' incorporates:
   *  Gain: '<Root>/Gain1'
   */
  inline_variants_example_Y.Outport = 3.0 * rtb_VariantMerge_For_Variant_So;

  /* Gain: '<Root>/Gain' */
#if W == 1

  rtb_VariantMerge_For_Variant__e = 2.0 * rtb_VariantMerge_For_Variant_So;

#endif

  /* End of Gain: '<Root>/Gain' */

  /* Outport: '<Root>/Outport1' incorporates:
   *  Gain: '<Root>/Gain2'
   */
  inline_variants_example_Y.Outport1 = 4.0 * rtb_VariantMerge_For_Variant__e;

  /* Update for Sin: '<Root>/Sine2' incorporates:
   *  Sin: '<Root>/Sine3'
   */
#if V == 2

  inline_variants_example_DW.counter++;
  if (inline_variants_example_DW.counter == 10) {
    inline_variants_example_DW.counter = 0;
  }

  inline_variants_example_DW.counter_g++;
  if (inline_variants_example_DW.counter_g == 10) {
    inline_variants_example_DW.counter_g = 0;
  }

#endif

  /* End of Update for Sin: '<Root>/Sine2' */

  /* Update for Sin: '<Root>/Sine4' incorporates:
   *  Sin: '<Root>/Sine5'
   */
#if W == 2

  inline_variants_example_DW.counter_c++;
  if (inline_variants_example_DW.counter_c == 10) {
    inline_variants_example_DW.counter_c = 0;
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  }

  inline_variants_example_DW.counter_i++;
  if (inline_variants_example_DW.counter_i == 10) {
    inline_variants_example_DW.counter_i = 0;
  }

#endif

  /* End of Update for Sin: '<Root>/Sine4' */

  /* Update for Sin: '<Root>/Sine1' */
#if V == 1

  inline_variants_example_DW.counter_m++;
  if (inline_variants_example_DW.counter_m == 10) {
    inline_variants_example_DW.counter_m = 0;
  }

#endif

  /* End of Update for Sin: '<Root>/Sine1' */
}

The variables rtb_VariantMerge_For_Variant_So and rtb_VariantMerge_For_Variant_e
hold the input values to the Variant Source blocks. Notice that the code for these variables is
conditional. The variables inline_variants_example_Y.Outport and
inline_variants_example_Y.Outport1 hold the output values of the Variant Source blocks.
Notice that the code for these variables is not conditional.

Generate Code with Zero Active Variant Controls
You can generate code in which blocks connected to the input and the output of a Variant Source
block are conditional.

1 For Variant Source, open the Block Parameters dialog box. Select the parameter Allow zero
active variant controls.

2 For Variant Source 1, open the Block Parameters dialog box. Select the parameter Allow
zero active variant controls.

When you select the Allow zero active variant controls parameter, you can generate code for a
model containing Variant Source and Variant Sink blocks even when you specify a value for a variant
control variable that does not allow for an active variant. Choosing a value for a variant control
variable that does not allow for an active variant and not selecting the Allow zero active variant
controls parameter, produces an error.

Generate code for inline_variants_example. Notice in the inline_variants_example.c file,
that the code for the variables inline_variants_example_Y.Outport1 and
inline_variants_example_Y.Outport2 is conditional.

/* Model step function */
void inline_variants_example_step(void)
{
 ...
#if V == 1 || V == 2
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  inline_variants_example_Y.Outport = 3.0 * rtb_VariantMerge_For_Variant_So;

#endif

 ...
#if (V == 1 && W == 1) || (V == 2 && W == 1) || W == 2

  inline_variants_example_Y.Outport1 = 4.0 * rtb_VariantMerge_For_Variant__e;

#endif
 
 ...

See Also

Related Examples
• “Define and Configure Variant Sources and Sinks”
• “Variant Condition Propagation with Variant Sources and Sinks”
• “Introduction to Variant Controls”
• “Create Custom Check to Evaluate Active and Inactive Variant Paths from a Model” (Simulink

Check)
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Configure Dimension Variants for S-Function Blocks
To configure symbolic dimensions for S-function blocks, you can use the following C/C++ functions.
You can configure S-functions to support forward propagation, backward propagation, or forward and
backward propagation of symbolic dimensions during simulation.

Many of these functions return the variable SymbDimsId. A SymbDimsId is a unique integer value.
This value corresponds to each symbolic dimension specification that you create or is the result of a
mathematical operation that you perform with symbolic dimensions.

C/C++ S-Functions Purpose
ssSetSymbolicDimsSupport Specify whether or not an S-function

supports symbolic dimensions.
mdlSetInputPortSymbolicDimensions Specify the symbolic dimensions of an input

port and how those dimensions propagate
forward.

mdlSetOutputPortSymbolicDimensions Specify the symbolic dimensions of an
output port and how those dimensions
propagate backward.

ssRegisterSymbolicDimsExpr Create a SymbDimsId from an expression
string (aExpr). The expression string must
form a valid syntax in C.

ssRegisterSymbolicDims Create a SymbDimsId from a vector of
SymbDimsIds.

ssRegisterSymbolicDimsString Create a SymbDimsId from an identifier
string (aString).

ssRegisterSymbolicDimsIntValue Create a SymbDimsId from an integer value
(aIntValue)

ssRegisterSymbolicDimsPlus Create a SymbDimsId by adding two
symbolic dimensions.

ssRegisterSymbolicDimsMinus Create a SymbDimsId by subtracting two
symbolic dimensions.

ssRegisterSymbolicDimsMultiply Create a SymbDimsId by multiplying two
symbolic dimensions.

ssRegisterSymbolicDimsDivide Create a SymbDimsId by dividing two
symbolic dimensions.

ssGetNumSymbolicDims Get the number of dimensions for a
SymbDimsId.

ssGetSymbolicDim Get a SymbDimsId from a vector of
SymbDimsIds.

ssSetInputPortSymbolicDimsId Set the precompiled SymbDimsId of an
input port. You can call this function from
inside the mdlInitializeSizes function.

ssGetCompInputPortSymbolicDimsId Get the compiled SymbDimsId of an input
port.
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C/C++ S-Functions Purpose
ssSetCompInputPortSymbolicDimsId Set the compiled SymbDimsId of an input

port.
ssSetOutputPortSymbolicDimsId Set the precompiled SymbDimsId of an

output port. You can call this function from
inside the mdlInitializeSizes function.

ssGetCompOutputPortSymbolicDimsId Get the compiled SymbDimsId of an output
port.

ssSetCompOutputPortSymbolicDimsId Set the compiled SymbDimsId of an output
port.

ssSetCompDWorkSymbolicDimsId Set the compiled SymbDimsId of an index of
a block’s data type work (DWork) vector.

S-Function That Supports Forward Propagation of Symbolic
Dimensions
The model ex_msymbdims_sfcn_one contains an S-function that subtracts the symbolic dimension
B from a symbolic input dimension, A + B. It does not support backward propagation of symbolic
dimensions because the compiled symbolic dimensions of the input ports are not set. Symbolic
dimensions are set for the output port, so forward propagation occurs.

After simulation, the model shows the propagated dimensions.

The sfun_symbdims_sfcn_one.c file contains this code.
#define S_FUNCTION_NAME  sfun_symbdims_sfcn_one
#define S_FUNCTION_LEVEL 2

#include "simstruc.h"

#include <assert.h>

/* Function: mdlInitializeSizes ===============================================
 * Abstract:
 *   Setup sizes of the various vectors.
 */
static void mdlInitializeSizes(SimStruct *S)
{
    ssSetNumSFcnParams(S, 0); /* Number of expected parameters */
    
    ssSetNumContStates(S, 0);
    ssSetNumDiscStates(S, 0);

    if (!ssSetNumInputPorts(S, 1)) return;
    ssSetInputPortDirectFeedThrough(S, 0, 1);
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    ssSetInputPortDimensionInfo(S, 0, DYNAMIC_DIMENSION);
    ssSetInputPortRequiredContiguous(S, 0, 1);
    
    if (!ssSetNumOutputPorts(S,1)) return;
    ssSetOutputPortDimensionInfo(S, 0, DYNAMIC_DIMENSION);   
    ssSetNumSampleTimes(S, 1);

    ssSetNumRWork(S, 0);
    ssSetNumIWork(S, 0);
    ssSetNumPWork(S, 0);

    ssSetNumModes(S, 0);
    ssSetNumNonsampledZCs( S, 0);
    
    ssAllowSignalsWithMoreThan2D(S);
    
    ssSetOptions(S, SS_OPTION_EXCEPTION_FREE_CODE);
    
    ssSetSymbolicDimsSupport(S, true);
}

/*If underspecified for propagation, say i/o are scalars.*/
#if defined(MATLAB_MEX_FILE)
#define MDL_SET_DEFAULT_PORT_DIMENSION_INFO
static void mdlSetDefaultPortDimensionInfo(SimStruct *S)
{
    if( (ssGetOutputPortWidth(S, 0) == DYNAMICALLY_SIZED) 
        && (ssGetInputPortWidth(S, 0) == DYNAMICALLY_SIZED) ) {
        ssSetOutputPortMatrixDimensions(S, 0, 1, 1 );
    }
}
#endif

#if defined(MATLAB_MEX_FILE)
#define MDL_SET_INPUT_PORT_SYMBOLIC_DIMENSIONS
static void mdlSetInputPortSymbolicDimensions(SimStruct* S, 
   int_T portIndex, SymbDimsId symbDimsId)
{
    assert(0 == portIndex);
    // Set the compiled input symbolic dimension.
    ssSetCompInputPortSymbolicDimsId(S,  portIndex, symbDimsId);
    // Register "B" and get its symbolic dimensions id.
    const SymbDimsId symbolId = ssRegisterSymbolicDimsString(S, "B");
    // Subtract "B" from the input symbolic dimension.
    const SymbDimsId outputDimsId = 
       ssRegisterSymbolicDimsMinus(S, symbDimsId, symbolId);
    ssSetCompOutputPortSymbolicDimsId(S, portIndex, outputDimsId);
}
#endif

#if defined(MATLAB_MEX_FILE)
#define MDL_SET_OUTPUT_PORT_SYMBOLIC_DIMENSIONS
static void mdlSetOutputPortSymbolicDimensions(SimStruct *S, 
   int_T portIndex, SymbDimsId symbDimsId)
{
    assert(0 == portIndex);
   // The input dimensions are not set, so this S-function only
    // supports forward propagation.
    ssSetCompOutputPortSymbolicDimsId(S, portIndex, symbDimsId);
}
#endif

/* Function: mdlInitializeSampleTimes =========================================
 * Abstract:
 *    Specify that we inherit our sample time from the driving block.
 *    However, we don't execute in minor steps.
 */
static void mdlInitializeSampleTimes(SimStruct *S)
{
    ssSetSampleTime(S, 0, INHERITED_SAMPLE_TIME);
    ssSetOffsetTime(S, 0, 0.0);
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    ssSetModelReferenceSampleTimeDefaultInheritance(S);    
}
/* Function: mdlOutputs =======================================================
 * Abstract:
 *    y=u';
 */
static void mdlOutputs(SimStruct *S, int_T tid)
{
}

/* Function: mdlTerminate =====================================================
 * Abstract:
 *    No termination needed, but we are required to have this routine.
 */
static void mdlTerminate(SimStruct *S)
{
    UNUSED_ARG(S); /* unused input argument */
}

#ifdef  MATLAB_MEX_FILE    /* Is this file being compiled as a MEX-file? */
#include "simulink.c"      /* MEX-file interface mechanism */
#else
#include "cg_sfun.h"       /* Code generation registration function */
#endif

The Simulink.Parameter objects A and B contain these definitions.

A = Simulink.Parameter;
A.DataType = 'int32';
A.Value = 6;
A.Min=5;
A.Max=7;
A.CoderInfo.StorageClass = 'Custom';
A.CoderInfo.CustomStorageClass = 'ImportedDefine';
A.CoderInfo.CustomAttributes.HeaderFile = 'ImportedDefinitions.h';

B = Simulink.Parameter;
B.DataType = 'int32';
B.Value = 10;
B.Min=9;
B.Max=11;
B.CoderInfo.StorageClass = 'Custom';
B.CoderInfo.CustomStorageClass = 'ImportedDefine';
B.CoderInfo.CustomAttributes.HeaderFile = 'ImportedDefinitions.h';

The ImportedDefinitions header file contains this code.

#ifndef _IMPORTEDDEFINITIONS_H_
#define _IMPORTEDDEFINITIONS_H_
#define A 6
#define B 10
#endif

In the Configuration Parameters dialog box, the Custom Code pane contains the #include
statement.

#include "ImportedDefinitions.h"

The sfun_symbdims_sfcn_one S-function is inlined, so a TLC file with this code must be present on
the path with the model and other supporting files.
%implements "sfun_symbdims_sfcn_two" "C"

%function BlockInstanceSetup(block, system) void
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%endfunction

%% Function: BlockOutputSignal =================================================
%function BlockOutputSignal(block,system,portIdx,ucv,lcv,idx,retType) void
%endfunction

%% Function: Outputs ===========================================================
%%
%function Outputs(block, system) Output

  %assign rollVars = ["U", "Y"]
  %roll idx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
    %%
    %assign u  = LibBlockInputSignal( 0, "", lcv, idx)
    %assign y  = LibBlockOutputSignal(0, "", lcv, idx)
                                                           
    %<y> = %<u>;
                                                      
  %endroll

%endfunction %% Outputs

To generate a MEX function, at the command-line, enter this command:

mex sfun_symbdims_sfcn_one.c

Generate code for the model. The ex_msymbdims_sfcn_one_step function contains this code. The
S-function code is set inline.

/* Model step function */
void ex_msymbdims_sfcn_one_step(void)
{
  int32_T i;

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In1'
   */
  for (i = 0; i < A; i++) {
    ex_msymbdims_sfcn_one_B.MatrixConcatenate[i] = 2.0 *
      ex_msymbdims_sfcn_one_U.In1[i];
  }

  /* End of Gain: '<Root>/Gain' */

  /* Gain: '<Root>/Gain2' incorporates:
   *  Inport: '<Root>/In2'
   */
  for (i = 0; i < B; i++) {
    ex_msymbdims_sfcn_one_B.MatrixConcatenate[A + i] = 2.0 *
      ex_msymbdims_sfcn_one_U.In2[i];
  }

  /* End of Gain: '<Root>/Gain2' */

  /* S-Function (sfun_symbdims_sfcn_one): '<Root>/Minus' incorporates:
   *  Outport: '<Root>/Out7'
   */
  {
    int_T i1;
    const real_T *u0 = &ex_msymbdims_sfcn_one_B.MatrixConcatenate[0];
    real_T *y0 = &ex_msymbdims_sfcn_one_Y.Out7[0];
    for (i1=0; i1 < ((A + B)); i1++) {
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      y0[i1] = u0[i1];
    }
  }
}

S-Function That Supports Forward and Backward Propagation of
Symbolic Dimensions
This S-function transposes two symbolic dimensions. It supports forward and backward propagation
of symbolic dimensions because the compiled symbolic dimension of both the input and output ports
are set.

static void mdlInitializeSizes(SimStruct *S)
{
     // Enable symbolic dimensions for the s-function.
     ssSetSymbolicDimsSupport(S, true);
}

#if defined(MATLAB_MEX_FILE)
#define MDL_SET_INPUT_PORT_SYMBOLIC_DIMENSIONS
static void mdlSetInputPortSymbolicDimensions(SimStruct* S, 
   int_T portIndex, SymbDimsId symbDimsId)
{
    assert(0 == portIndex);
    
    ssSetCompInputPortSymbolicDimsId(S,  portIndex, symbDimsId);
    
    assert(2U == ssGetNumSymbolicDims(S, symbDimsId));
    
    if (SL_INHERIT == 
        ssGetCompOutputPortSymbolicDimsId(S, portIndex)) {

        const SymbDimsId idVec[] = {
            ssGetSymbolicDim(S, symbDimsId, 1),
            ssGetSymbolicDim(S, symbDimsId, 0)};
        // Register the transposed dimensions.
       // Set the output symbolic dimension to the resulting id.
  const SymbDimsId outputDimsId = 
            ssRegisterSymbolicDims(S, idVec, 2U);

        ssSetCompOutputPortSymbolicDimsId(S, portIndex, 
           outputDimsId);
    }
}
#endif

#if defined(MATLAB_MEX_FILE)
#define MDL_SET_OUTPUT_PORT_SYMBOLIC_DIMENSIONS
static void mdlSetOutputPortSymbolicDimensions(SimStruct *S, 
    int_T portIndex, SymbDimsId symbDimsId)
{
    assert(0 == portIndex);
    ssSetCompOutputPortSymbolicDimsId(S, portIndex, symbDimsId);

    assert(2U == ssGetNumSymbolicDims(S, symbDimsId));
    
    if (SL_INHERIT == 
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        ssGetCompInputPortSymbolicDimsId(S, portIndex)) {

        const SymbDimsId idVec[] = {
            ssGetSymbolicDim(S, symbDimsId, 1),
            ssGetSymbolicDim(S, symbDimsId, 0)};
        const SymbDimsId inputDimsId = 
            ssRegisterSymbolicDims(S, idVec, 2U);
        // Register the transposed dimensions.
       // Set the input symbolic dimension to the resulting id.
        ssSetCompInputPortSymbolicDimsId(S, portIndex, inputDimsId);
    }
}
#endif

See Also

Related Examples
• “Implement Dimension Variants for Array Sizes in Generated Code” on page 26-2
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Represent Variant Condition Values of Enumerated Type in
Generated Code

You can generate C code from a Simulink model with variant condition variables or values of
Simulink-supported enumeration types. Enumerated types improve code readability because the
condition values and variables in control expressions are represented as meaningful names instead of
integers. In this section, you will learn:

• How to generate C code from a model with variant condition values of enumerated types.
• How the variant condition values are represented in the generated code.

Use Enumerated Type Derived From Built-In Integer
This example shows how to generate C code from a Simulink model with variant condition values of
enumerated type derived from the built-in integer int32.

Open the slexVariantSetupUsingIntEnums model. This model runs the PostLoadFcn defined in
the File > ModelProperties > Callbacks dialog. This function populates the base workspace with
the control variables for the variant blocks.

In this model, the Variant Sink and the Variant Source blocks specify two potential variants for the
Linear controller and Nonlinear controller subsystems. The control expression for the Linear
controller subsystem is V == ControllerChoice.Linear. The control expression for the
Nonlinear controller subsystem is V == ControllerChoice.NonLinear. Here,
ControllerChoice is an integer-based enumeration class derived from the built-in data type,
int32. The class is defined in the ControllerChoice.m file. The class has two enumeration values,
Linear and Nonlinear. These enumerated values have underlying integer values 0 and 1.

Switch Between Variant Choices

1 Click Simulation > Run and see the variant conditions being propagated to the blocks. By
default, the model simulates for the Linear controller subsystem.
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2 To modify the active choice, set the value of V to ControllerChoice.Nonlinear, then
simulate the model again. The model simulates for the Nonlinear controller subsystem.

Generate Code from Model

Before you generate code from the model, you must first ensure that you have write permission in
your current folder.

1 To generate code, in the Apps gallery of the model toolstrip, click Embedded Coder. The C
Code tab appears.

2
Click the Generate Code > Build icon. ( ).

Review Generated Code

1 In the C Code tab of the toolstrip, select Open Report.
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In the generated code, the variant control values ControllerChoice.Linear and
ControllerChoice.Nonlinear are converted to ControllerChoice_Linear and
ControllerChoice_Nonlinear, respectively. A valid C processor recognizes this format. The
code also includes the definitions of macros corresponding to these variants. The active variant is
determined by using preprocessor conditionals (#if) on the macros (#define)
ControllerChoice_Linear and ControllerChoice_Nonlinear.
#if V == ControllerChoice_Linear

slexVariantSetupUsingIntEnums_B.VariantMerge_For_Variant_Source =
slexVariantSetupUsingIntEnums_P.DiscreteTransferFcn_NumCoef_a *
slexVariantSetupUsingIntEnum_DW.DiscreteTransferFcn_states_o;

#endif

#if V == ControllerChoice_Nonlinear

slexVariantSetupUsingIntEnums_B.VariantMerge_For_Variant_Source =
look1_binlxpw(slexVariantSetupUsingIntEnums_P.DiscreteTransferFcn_NumCoef_l *
slexVariantSetupUsingIntEnum_DW.DiscreteTransferFcn_states_n,
slexVariantSetupUsingIntEnums_P.uDLookupTable_bp01Data,
slexVariantSetupUsingIntEnums_P.uDLookupTable_tableData, 10U);

#endif
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2 To view the definitions of macros, ControllerChoice_Linear and
ControllerChoice_Nonlinear, click the Controller.h file in the Generated Code pane of
the report.

#define ControllerChoice_Linear     (0)  /* Default value */
#define ControllerChoice_Nonlinear  (1)
#endif                                  /* RTW_HEADER_Controller_h_ */

3 To view the definition of the variant control variable, V, click the
slexVariantSetupUsingIntEnums_types.h file.

#ifndef V
#define V                              ControllerChoice_Linear
#endif

Use In-Memory Enumerated Type Derived From Simulink.IntEnumType
The Simulink model in this example shows how to generate C code from a model having variant
control variables of enumerated type derived from Simulink.IntEnumType.

1 Open the slexVariantSetupUsingInMemoryEnums model. The model runs the PreLoadFcn
defined in the File > ModelProperties > Callbacks dialog. This populates the base workspace
with the control variables for the variant blocks.

2 Generate C code. The variant control variables Controller.Linear and
Controller.Nonlinear are represented as Controller_Linear and
Controller_Nonlinear in the generated code, as the above example also shows.

The macros Controller_Linear and Controller_Nonlinear are defined in the
Controller.h file.

#define Controller_Linear     (0)  /* Default value */
#define Controller_Nonlinear  (1)
#endif                                  /* RTW_HEADER_Controller_h_ */

The variant control variable is defined in the
slexVariantSetupUsingInMemoryEnums_types.h file.

#ifndef V
#define V                              Controller_Linear
#endif

See Also

Related Examples
• “Represent Variant Source and Sink Blocks in Generated Code” on page 26-36
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Options to Represent Variant Parameters in Generated Code
You can generate the code only for active values or for both active and inactive values of variant
parameters in Simulink. You can also represent the values of variant parameters as inline variables or
as tunable variables in the generated code.

Note To generate code only for active values of variant parameters, you must install Simulink Coder.
To generate code for active and inactive values of variant parameters, you must install Embedded
Coder.

Overview of Variant Parameters
Variant parameters can have multiple values. Each value of the variant parameter is associated with a
variant condition expression. During simulation, the value of a variant parameter associated with the
condition that evaluates to true is the active value of the variant parameter. The value associated
with the condition that evaluates to false is the inactive value of the variant parameter. When you
generate code, you can choose to include only the active value or both the active and inactive values
in the generated code. You can also choose to represent the values as inline or as tunable variables in
the generated code. For more information on variant parameters, see “Use Variant Parameters to
Reuse Block Parameters with Different Values”.

Choice of Values in Generated Code
Simulink supports generating code only for active values or for both active and inactive values of
variant parameters. Values included in the code are based on the variant activation time you specify
for the variant parameters.

When you specify the “Variant activation time” as:

• update diagram –– Simulink sets the active values of variant parameters during update diagram
before the propagation of signal attributes. Inactive choices are removed prior to propagation of
signal attributes. Signal attributes such as dimension and data type are not analyzed for
consistency across the model. The generated code contains only the active value of variant
parameters.

• update diagram analyze all choices–– Simulink sets the active values of variant
parameters during update diagram after the propagation of signal attributes. Signal attributes are
propagated to both active and inactive values. Signal attributes such as dimension and data type
are analyzed for consistency across the model. The generated code contains only the active value
of variant parameters.

• code compile ––Simulink sets the active choice during code compile. Signal attributes are
propagated to both active and inactive values. Signal attributes such as dimension and data type
are analyzed for consistency across the model. The generated code contains both active and
inactive values of the variant parameters. The values are enclosed in C preprocessor conditional
statements #if and #endif.

Types of Variables in Generated Code
Simulink supports representing the values of variant parameters as inline variables or as tunable
variables in the generated code. The representation of values in the code are based on the storage
class you specify for the variant parameters.
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• Inline variable: If you specify the storage class of a variant parameter as “Auto”, which is a
default storage class, and the activation time as update diagram or update diagram
analyze all choices, then the variant parameter is inlined to the literal numeric value of the
parameter in the generated code. If you specify the storage class of a variant parameter as Auto
and the activation time as code compile, then the variant parameter is inlined as macros in the
generated code. Inlined variables reduce global RAM usage and increase efficiency of the
generated code. The code does not allocate memory to represent numeric block parameters, such
as the Gain parameter of a Gain block. Instead, the code is inlined to the literal numeric value of
the parameter.

• Tunable: If you specify the storage class of a variant parameter as anything other than Auto, then
the variant parameter is represented using symbolic names in the generated code, as described in
“Choose Storage Class for Controlling Data Representation in Generated Code”.

Generate C Code for Variant Parameters
This example shows how to generate C code for variant parameters. The style of the generated code
is based on the variant activation time and the storage class you specify for the variant parameters.

Explore the Model

Consider the slexVariantParameters.slx model.

The Gain parameters of the Gain1 and the Gain2 blocks are variant parameters with their values set
to K1 and K2, respectively. The variable K1 has two values: 3.5 and 8.5. The variable K2 has two
values: 4.5 and 9.5.

Simulink chooses active values of K1 and K2 based on the value of the variant control variable V. If
V==1 evaluates to true, then the value of K1 is set to 3.5, and the value of K2 is set to 8.5. If V==2
evaluates to true, then the value of K1 is set to 4.5, and the value of K2 is set to 9.5.

The style of generated code is based on the variant activation time and the storage class you specify
for the variant parameters. In this example, the variant activation time is set to update diagram,
and the storage class is set as Auto. When you generate a code from this model, the code is
generated only for the active values of K1 and K2. In the generated code, the values are inlined to the
literal value of the parameters.

26 Variant Systems in Embedded Coder

26-56

matlab: open_system([matlabroot '/examples/simulink_variants/main/slexVariantParameters]))


Generate Inline and Tunable Code Using Simulink Coder

Before you generate code from the model, you must first ensure that you have write permission in
your current folder.

1 Prepare the model for code generation by specifying code generation settings in the
Configuration Parameters dialog box. Choose the appropriate solver and code generation target,
and check the model configuration for execution efficiency. For more details on each of these
steps, see “Generate Code Using Simulink® Coder™”.

2 In the Apps gallery of the model toolstrip, click Simulink Coder.
3 On the C Code tab, click Build.

The code generator creates the folder slexVariantParameters_ert_rtw in your current
working folder and places source code files in that folder. The generated code is in two primary
files: slexVariantParameters.c and slexParameters.h. The file
slexVariantParameters.h contains the value of the variant control variable, and the file
slexVariantParameters.c contains the values of the variant parameters.

4 In the C Code tab, select Open Report.
5 Select the slexVariantParameters.c file from the Generated Code pane of the report. The

code is generated only for the active values of the K1 and K2. In the generated code, the values
are inlined to the literal value of the parameters.

mUDInlined_Y.Out1 = 4.5 * mUDInlined_U.In1; 
mUDInlined_Y.Out2 = 3.5 * mUDInlined_U.In2;

6 In the model, change the activation time to code compile and the storage class to
ExportedGlobal, then generate the code again. Observe the change in the style of the
generated code.

The code is generated only for all the active and inactive values of K1 and K2. In the generated
code, the values are represented using symbolic names.

This table shows the difference in the style of the generated code for storage classes Auto and
ExportedGlobal with different activation times.

Activation time Storage class
Auto (default) ExportGlobal
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update diagram The code is generated only
for the active values of the
variant parameters. In the
generated code, the values
are inlined to the literal value
of the parameters.

Consider this snippet of the
generated code. 4.5 and 3.5
are inline active values of the
variant parameters Gain1
and Gain2.

mUDInlined_Y.Out1 = 4.5 * mUDInlined_U.In1; 
mUDInlined_Y.Out2 = 3.5 * mUDInlined_U.In2;

The code is generated only
for the active values of
variant parameters. In the
generated code, the values
are represented using
symbolic names.

Consider this snippet of the
generated code. Here, K1
and K2 are symbolic names
for active values of variant
parameters Gain1 and
Gain2.

real_T K1 = 3.5;
real_T K2 = 4.5;
…
…
mUDInlined_Y.Out1 = K2 * mUDInlined_U.In2; 
mUDInlined_Y.Out2 = K1 * mUDInlined_U.In1;

update diagram analyze
all choices

The generated code is same
as that of update diagram.
The only difference is that
the active and the inactive
values of variant parameters
are analyzed to ensure
consistency of signal
attributes such as dimension
and data type across the
model.

The generated code is same
as that of update diagram.
The only difference is that
the active and the inactive
values of variant parameters
are analyzed to ensure
consistency of signal
attributes such as dimension
and data type across the
model.
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code compile The code is generated for all
the active and inactive values
of the variant parameters. All
of the values are analyzed to
ensure consistency of signal
attributes such as dimension
and data type across the
model. In the generated
code, the values are inlined
as macros.

Consider this snippet of the
generated code. The active
and inactive values are
enclosed in C preprocessor
conditional statements #if
and #endif.
rtCP_Gain1_K1 and
rtCP_Gain_K2 are the
macros for variant
parameters Gain1 and
Gain2.

#if V == 1 
#define rtCP_Gain1_K1     (3.5)
#elif V == 2
#define rtCP_Gain1_K1     (8.5) 
#endif

#if V == 1 
#define rtCP_Gain_K2      (4.5)
#elif V == 2
#define rtCP_Gain_K2      (9.5)
#endif

mUDInlined_Y.Out1 = rtCP_Gain_K2 * mUDInlined_U.In2;
mUDInlined_Y.Out2 = rtCP_Gain1_K1 * mUDInlined_U.In1;

The code is generated for all
the active and inactive values
of variant parameters. All of
the values are analyzed to
ensure consistency of signal
attributes such as dimension
and data type across the
model. In the generated
code, the values are
represented using symbolic
names.

Consider this snippet of the
generated code. The active
and inactive values are
enclosed in C preprocessor
conditional statements #if
and #endif. Here, K1 and
K2 are symbolic names for
variant parameters Gain1
and Gain2.

#if V == 1 
#real_T K1 = 3.5;
#elif V == 2
#real_T K1 = 8.5; 
#endif

#if V == 1 
#real_T K2 = 4.5;
#elif V == 2
#real_T K2 = 9.5;
#endif

mUDInlined_Y.Out1 = K2 * mUDInlined_U.In2;
mUDInlined_Y.Out2 = K1 * mUDInlined_U.In1;

See Also
“Use Variant Parameters to Reuse Block Parameters with Different Values” | “Choose Storage Class
for Controlling Data Representation in Generated Code”

Related Examples
• “Change Active Values and Activation Time of Variant Parameters”
• “Generate Preprocessor Conditionals for all Values of Variant Parameters”

 Options to Represent Variant Parameters in Generated Code

26-59



Generate Code for Variant Subsystem with Child Subsystems
of Different Output Signal Dimensions

In this section...
“Example Model” on page 26-60
“Simulate Model” on page 26-60
“Generate Code” on page 26-61

This example shows how to use symbolic dimensions to generate code with preprocessor conditionals
for a variant subsystem consisting of child subsystems of different output signal dimensions. The
value of the variant control variable determines the active variant choice and the output signal
dimensions. By changing the value of the variant control variable, you change the active variant and
the output signal dimensions in the generated code.

Example Model
The model slexVariantSymbolicDims contains a Variant Subsystem consisting of the child
subsystems Subsystem and Subsystem1. When the variant control variable Var has a value of 1,
Subsystem is the active variant. When Var has a value of 2, Subsystem1 is the active variant.

Simulate Model
To generate code with preprocessor conditionals, the output signal dimensions of the child
subsystems must be the same during simulation. In this example, double-clicking the subsystem
Activate Variant Choice changes the active variant and the output signal dimension. When Var

26 Variant Systems in Embedded Coder

26-60



equals 1, the output signal dimension of each child subsystem is 5. When Var equals 2, the output
signal dimension of each child subsystem is 6.

1 Open the example model slexVariantSymbolicDims.
2 On the Debug tab, select Information Overlays > Signal Dimensions.
3 Open the Variant Subsystem Block Parameters dialog box. The Variant activation time

parameter is set to code compile.
4 Open Subsystem. In the Constant Block Parameters dialog box, the Constant value parameter

is P1.
5 Open Subsystem1. In the Constant Block Parameters dialog box, the Constant value parameter

is P2.
6 Open the base workspace. The Simulink.Parameters P1 and P2 are arrays with dimensions

'[1,A]'. The Simulink.Parameter A has a value of 5. Var has a value of 1.
7 Simulate the model. Subsystem is the active variant with an output signal dimension of 5.
8 Double-click the masked subsystem ActivateVariant.
9 In the base workspace, Var has a value of 2. P1 and P2 have a dimension of 6. A has a value of 6.
10 Simulate the model. Subsystem1 is the active variant with an output signal dimension of 6.

In the base workspace, A has a Storage class of ImportedDefine(Custom). To use a
Simulink.Parameter object for dimension specification, it must have one of these storage classes:

• Define or ImportedDefine with header file specified
• CompilerFlag
• User-defined custom storage class that defines data as a macro in a specified header file

In the base workspace, P1 and P2 have a storage class of ImportedExtern. A
Simulink.Parameter object that uses a Simulink.Parameter for symbolic dimension
specification must have a storage class of either ImportedExtern or ImportedExternPointer, or
a storage class with the Data initialization property set to None.

Generate Code
1 Open the header file slexVariantSymbolicDims_variant_defines.h. The definition of A is

conditional upon the value of Var.

/* Copyright 2016 The MathWorks, Inc. */
// To select variant choice during compile, define Var at compile time, 

#ifndef Var
#define Var 1
#endif

#if Var == 1
#define A 5
#elif Var == 2
#define A 6
#else
#error "Variant control variable, Var, must be defined as 1 or 2"
#endif

2 Generate code.
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3 Open the slexVariantSymbolicDims.h file. The output dimension size is A.

/* External outputs (root outports fed by signals with auto storage) */
typedef struct {
  int32_T Out1[A];                     /* '<Root>/Out1' */
} ExternalOutputs_slexVariantSymb;

4 Open the slexVariantSymbolicDims.c file. If Var equals 1, P1 has five values. If Var equals
2, P2 has six values. In the Configuration Parameters dialog box, on the Code Generation >
Custom Code pane, the Source file parameter contains this code.

/* user code (top of source file) */
#if Var == 1

int32_T P1[] = { 5, 5, 5, 5, 5 };

#elif Var == 2

int32_T P2[] = { 6, 6, 6, 6, 6, 6 };

#endif

Preprocessor conditionals control the size of A and which array, P1 or P2, is active in the
generated code. By changing the value of Var, you can change the size of A and the active array.

See Also

Related Examples
• “Implement Dimension Variants for Array Sizes in Generated Code” on page 26-2
• “Represent Subsystem and Variant Models in Generated Code” on page 26-21
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Use Variant Subsystem To Generate Code That Uses C
Preprocessor Conditionals

This example shows how to use Simulink® variant subsystems to generate C preprocessor
conditionals that control which child subsystem of the variant subsystem is active in the generated
code produced by the Simulink® Coder™.

Overview of Variant Subsystems

A Variant Subsystem block contains two or more child subsystems where one child is active during
model execution. The active child subsystem is referred to as the active variant. You can
programmatically switch the active variant of the Variant Subsystem block by changing values of
variables in the base workspace, or by manually overriding variant selection using the Variant
Subsystem block dialog. The active variant is programmatically wired to the Inport and Outport
blocks of the Variant Subsystem by Simulink® during model compilation.

To programmatically control variant selection, a Simulink.Variant object is associated with each
child subsystem in the Variant Subsystem block dialog. Simulink.Variant objects are created in
the MATLAB® base workspace. These objects have a property named Condition, an expression,
which evaluates to a Boolean value and is used to determine the active variant child subsystem.

By default the generated code contains only the active variant. Alternatively, you can parameterize
the selection of the active variant, and make it dependent on the values of variables and objects in the
base MATLAB® workspace. When you generate code, you can generate code for all variants and
defer the choice of active variant until it is time to compile that code.

Specifying Variants for a Subsystem Block

Opening the example model rtwdemo_preprocessor_subsys will run the PostLoadFcn defined in
the "File: ModelProperties: Callbacks" dialog. This will populate the base workspace with the
variables for the Variant Subsystem blocks.

open_system('rtwdemo_preprocessor_subsys')
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The LeftController variant subsystem contains two child subsystems: Linear and Nonlinear. The
LeftController/Linear child subsystem executes when the Simulink.Variant object LINEAR evaluates
to true, and the LeftController/Nonlinear child subsystem executes when the Simulink.Variant object
NONLINEAR evaluates to true.

Simulink.Variant objects are specified for the LeftController subsystem by right-clicking the
LeftController subsystem and selecting Subsystem Parameters, which will open the LeftController
subsystem block dialog.

open_system('rtwdemo_preprocessor_subsys/LeftController');

The LeftController subsystem block dialog creates an association between the Linear and Nonlinear
subsystems with the two Simulink.Variant objects, LINEAR and NONLINEAR, that exist in the base
workspace. These objects have a property named Condition, an expression, which evaluates to a
Boolean value and determines the active variant child subsystem (Linear or Nonlinear). The condition
is also shown in the subsystem block dialog. In this example, the conditions of LINEAR and
NONLINEAR are 'VSSMODE == 0' and 'VSSMODE == 1', respectively.

In this example, the Simulink.Variant objects are created in the base workspace.

LINEAR = Simulink.Variant;
LINEAR.Condition = 'VSSMODE==0';
NONLINEAR = Simulink.Variant;
NONLINEAR.Condition = 'VSSMODE==1';

Specifying a Variant Control Variable

Variant objects allow you to reuse arbitrarily complex conditions throughout a model. Multiple
Variant Subsystem blocks can use the same Simulink.Variant objects, allowing you to toggle the
activation of choices as a set. You can toggle the set prior to simulation by changing the value of
VSSMODE in the MATLAB environment or when compiling the generated code, as explained in the
next section. In this example, LeftController and RightController reference the same variant objects,
so that you can toggle them simultaneously.

The nonlinear controller subsystems implement hysteresis, while the linear controller subsystems act
as simple low-pass filters. Open the subsystem for the left channel. The subsystems for the right
channel are similar.
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The generated code accesses the variant control variable VSSMODE as a user-defined macro. In this
example, rtwdemo_importedmacros.h supplies VSSMODE. Within the MATLAB environment, you
specify VSSMODE using a Simulink.Parameter object. Its value will be ignored when generating
code including preprocessor conditionals. However, the value is used for simulation. The legacy
header file specifies the value of the macro to be used when compiling the generated code, which
ultimately activates one of the two specified variants in the embedded executable.

Variant control variables can be defined as Simulink.Parameter objects with one of these storage
classes:

• Define or ImportedDefine with header file specified
• CompilerFlag
• SystemConstant (AUTOSAR)
• User-defined custom storage class that defines data as a macro in a specified header file

VSSMODE = Simulink.Parameter;
VSSMODE.Value = 1;
VSSMODE.DataType = 'int32';
VSSMODE.CoderInfo.StorageClass = 'Custom';
VSSMODE.CoderInfo.CustomStorageClass = 'ImportedDefine';
VSSMODE.CoderInfo.CustomAttributes.HeaderFile = 'rtwdemo_importedmacros.h';

Simulating the Model with Different Variants

Because you set the value of VSSMODE to 1, the model uses the nonlinear controllers during
simulation.

sim('rtwdemo_preprocessor_subsys')
youtnl = yout;

If you change the value of VSSMODE to 0, the model uses the linear controllers during simulation.

VSSMODE.Value = int32(0);
sim('rtwdemo_preprocessor_subsys')
youtl = yout;

You can plot and compare the response of the linear and nonlinear controllers:

figure('Tag','CloseMe');
plot(tout, youtnl.signals(1).values, 'r-', tout, youtl.signals(1).values, 'b-')
title('Response of Left Channel Linear and Nonlinear Controllers');
ylabel('Response');
xlabel('Time (seconds)');
legend('nonlinear','linear')
axis([0 100 -0.8 0.8]);
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Using C Preprocessor Conditionals

This example model has been configured to generate C preprocessor conditionals. To generate code
for the model, in C Code tab of the toolstrip select Build.

To activate code generation of preprocessor conditionals, check whether the following conditions are
true:

• Select an Embedded Coder® target in Code Generation > System target file in the
Configuration Parameters dialog box

• In the Variant Subsystem block parameter dialog box, set the Variant activation time parameter
to code compile.

In this example, the generated code includes references to the Simulink.Variant objects LINEAR and
NONLINEAR, as well as the definitions of macros corresponding to those variants. Those definitions
depend on the value of VSSMODE, which is supplied in an external header file
rtwdemo_importedmacros.h. The active variant is determined by using preprocessor conditionals
(#if) on the macros (#define) LINEAR and NONLINEAR.

The macros LINEAR and NONLINEAR are defined in the generated
rtwdemo_preprocessor_subsys_types.h, header file:

  #ifndef LINEAR
  #define LINEAR      (VSSMODE == 0)
  #endif
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  #ifndef NONLINEAR
  #define NONLINEAR   (VSSMODE == 1)
  #endif

In the generated code, the code related to the variants is guarded by C preprocessor conditionals. For
example, in rtwdemo_preprocessor_subsys.c, the calls to the step and initialization functions of
each variant are conditionally compiled:

  /* Outputs for atomic SubSystem: '<Root>/LeftController' */
  #if LINEAR
      /* Output and update for atomic system: '<S1>/Linear' */
  #elif NONLINEAR
      /* Output and update for atomic system: '<S1>/Nonlinear' */
  #endif

Close the model, figure, and workspace variables from the example.

bdclose('rtwdemo_preprocessor_subsys')
close(findobj(0,'Tag','CloseMe'));
clear LINEAR NONLINEAR VSSMODE
clear tout yout youtl youtnl
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Use Variant Models to Generate Code That Uses C
Preprocessor Conditionals

This example shows you how to use variant models to generate code that uses preprocessor
conditionals to control which code is linked into the embedded executable.

Overview of Variant Models

You can use a Model block to reference one Simulink® model (the child model) from another
Simulink® model (the parent model). A Variant Subsystem block can have different variants. The
variants can include a set of Model blocks, from which the Variant Subsystem block selects one. The
figure below is a conceptual depiction of variant models. In this example the Right Controller
model block can potentially select from two Model blocks. The models referenced by the Model
blocks provide variations upon a nominal, prescribed functionality.

A Variant Subsystem block has only one variant active at a time. You can use the Variant Subsystem
block dialog to select the active variant. Alternatively, you can parameterize the selection of the
active variant, and make it dependent on the values of variables and objects in the base MATLAB®
workspace. When you generate code, you can generate code for all variants and defer the choice of
active variant until it is time to compile that code.

Specifying Variant Models

Opening the example model rtwdemo_preprocessor runs the PostLoadFcn defined in the "File:
ModelProperties: Callbacks" dialog. This populates the base workspace with the control variables for
the Variant Subsystem blocks.
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open_system('rtwdemo_preprocessor')

The Left Controller variant subsystem contains two child Model blocks: Linear and Nonlinear.
The Left Controller/Linear child model executes when the Simulink.Variant object LINEAR
evaluates to true, and the Left Controller/Nonlinear child model executes when the
Simulink.Variant object NONLINEAR evaluates to true.

Simulink.Variant objects are specified for the Left Controller subsystem by right-clicking the
Left Controller subsystem and selecting Subsystem Parameters, which opens the Left
Controller Variant Subsystem block dialog box.

The Left Controller subsystem block dialog creates an association between the Linear and
Nonlinear Model blocks with the two Simulink.Variant objects from the base workspace,
LINEAR and NONLINEAR. These objects have a property named Condition, which is an expression
that evaluates to a Boolean value and determines the active variant model (Linear or Nonlinear).
The condition is also shown in the subsystem block dialog. In this example, the conditions of LINEAR
and NONLINEAR are 'VSSMODE == 0' and 'VSSMODE == 1', respectively.
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In this example, Simulink.Variant objects are created in the base workspace.

LINEAR = Simulink.Variant;
LINEAR.Condition = 'VSSMODE==0';
NONLINEAR = Simulink.Variant;
NONLINEAR.Condition = 'VSSMODE==1';

Specifying a Variant Control Variable

Variant objects allow you to reuse arbitrarily complex conditions throughout a model. Multiple
Variant Subsystem blocks can use the same Simulink.Variant objects, allowing you to toggle the
activation of variant models as a set. You can toggle the set prior to simulation by changing the value
of VSSMODE in the MATLAB environment or when compiling the generated code, as explained in the
next section. In this example, Left Controller and Right Controller reference the same
variant objects, so that you can toggle them simultaneously.

The nonlinear controller models implement hysteresis, while the linear controller models act as
simple low-pass filters. Open the subsystem for the left channel. The models for the right channel are
similar.

The generated code accesses the variant control variable VSSMODE as a user-defined macro. In this
example, rtwdemo_importedmacros.h supplies VSSMODE. Within the MATLAB environment, you
specify VSSMODE using a Simulink.Parameter object. Its value will be ignored when generating
code including preprocessor conditionals. However, the value is used for simulation. The legacy
header file specifies the value of the macro to be used when compiling the generated code, which
ultimately activates one of the two specified variants in the embedded executable.

Variant control variables can be defined as Simulink.Parameter objects with one of these storage
classes:
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• Define or ImportedDefine with header file specified
• CompilerFlag
• SystemConstant (AUTOSAR)
• User-defined custom storage class that defines data as a macro in a specified header file

VSSMODE = Simulink.Parameter;
VSSMODE.Value = 1;
VSSMODE.DataType = 'int32';
VSSMODE.CoderInfo.StorageClass = 'Custom';
VSSMODE.CoderInfo.CustomStorageClass = 'ImportedDefine';
VSSMODE.CoderInfo.CustomAttributes.HeaderFile = 'rtwdemo_importedmacros.h';

Simulating the Model with Different Variants

Because you set the value of VSSMODE to 1, the model uses the nonlinear controllers during
simulation.

sim('rtwdemo_preprocessor')
youtnl = yout;

If you change the value of VSSMODE to 0, the model uses the linear controllers during simulation.

VSSMODE.Value = int32(0);
sim('rtwdemo_preprocessor')
youtl = yout;

You can plot and compare the response of the linear and nonlinear controllers:

figure('Tag','CloseMe');
plot(tout, youtnl.signals(1).values, 'r-', tout, youtl.signals(1).values, 'b-')
title('Response of Left Channel Linear and Nonlinear Controllers');
ylabel('Response');
xlabel('Time (seconds)');
legend('nonlinear','linear')
axis([0 100 -0.8 0.8]);
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Using C Preprocessor Conditionals

This example model has been configured to generate C preprocessor conditionals. To generate code
for the model, in C Code tab of the toolstrip select Build.

To activate code generation of preprocessor conditionals, check whether the following conditions are
true:

• Select an Embedded Coder® target in Code Generation > System target file in the
Configuration Parameters dialog box

• In the Variant Subsystem block parameter dialog box, set the Variant activation time parameter
to code compile.

In this example, the generated code includes references to the Simulink.Variant objects LINEAR
and NONLINEAR, as well as the definitions of macros corresponding to those variants. Those
definitions depend on the value of VSSMODE, which is supplied in an external header file
rtwdemo_importedmacros.h. The active variant is determined by using preprocessor conditionals
(#if) on the macros (#define) LINEAR and NONLINEAR.

The macros LINEAR and NONLINEAR are defined in the generated
rtwdemo_preprocessor_types.h header file:

  |#ifndef LINEAR|
  |#define LINEAR      (VSSMODE == 0)|
  |#endif|
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  |#ifndef NONLINEAR|
  |#define NONLINEAR   (VSSMODE == 1)|
  |#endif|

In the generated code, the code related to the variants is guarded by C preprocessor conditionals. For
example, in rtwdemo_preprocessor.c, the calls to the step and initialization functions of each
variant are conditionally compiled:

Close the model, figure, and workspace variables from the example.

bdclose('rtwdemo_preprocessor')
close(findobj(0,'Tag','CloseMe'));
clear LINEAR NONLINEAR VSSMODE
clear tout yout youtl youtnl
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• “Absolute and Elapsed Time Computation” on page 27-2
• “Access Timers Programmatically” on page 27-4
• “Generate Code for an Elapsed Time Counter” on page 27-7
• “Absolute Time Limitations” on page 27-10
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Absolute and Elapsed Time Computation
In this section...
“About Timers” on page 27-2
“Timers for Periodic and Asynchronous Tasks” on page 27-2
“Allocation of Timers” on page 27-2
“Integer Timers in Generated Code” on page 27-3
“Elapsed Time Counters in Triggered Subsystems” on page 27-3

About Timers
Certain blocks require the value of either absolute time (that is, the time from the start of program
execution to the present time) or elapsed time (for example, the time elapsed between two trigger
events). Targets that support the real-time model (rtModel) data structure provide efficient time
computation services to blocks that request absolute or elapsed time. Absolute and elapsed timer
features include

• Timers are implemented as unsigned integers in generated code.
• In multirate models, at most one timer is allocated per rate. If no blocks executing at a given rate

require a timer, a timer is not allocated to that rate. This minimizes memory allocated for timers
and significantly reduces overhead involved in maintaining timers.

• Allocation of elapsed time counters for use of blocks within triggered subsystems is minimized,
further reducing memory usage and overhead.

• S-function and TLC APIs let your S-functions access timers, in simulation and code generation.
• The word size of the timers is determined by a user-specified maximum counter value that you set

with model configuration parameter Application lifespan (days). If you specify this value, timers
do not overflow. For more information, see “Control Memory Allocation for Time Counters”.

See “Absolute Time Limitations” for more information about absolute time and the restrictions that it
imposes.

Timers for Periodic and Asynchronous Tasks
Timing services provided for blocks execute within periodic tasks (that is, tasks running at the model
base rate or subrates).

The code generator also provides timer support for blocks whose execution is asynchronous with
respect to the periodic timing source of the model. See the following topics:

• “Timers in Asynchronous Tasks” on page 29-39
• “Create a Customized Asynchronous Library” on page 29-41

Allocation of Timers
If you create or maintain an S-Function block that requires absolute or elapsed time data, it must
register the requirement (see “Access Timers Programmatically” on page 27-4). In multirate
models, timers are allocated on a per-rate basis. For example, consider a model structured as follows:
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• There are three rates, A, B, and C, in the model.
• No blocks running at rate B require absolute or elapsed time.
• Two blocks running at rate C register a requirement for absolute time.
• One block running at rate A registers a requirement for absolute time.

In this case, two timers are generated, running at rates A and C respectively. The timing engine
updates the timers as the tasks associated with rates A and C execute. Blocks executing at rates A
and C obtain time data from the timers associated with rates A and C.

Integer Timers in Generated Code
In the generated code, timers for absolute and elapsed time are implemented as unsigned integers.
The default size is 64 bits. This is the amount of memory allocated for a timer if you set model
configuration parameter Application lifespan (days) to inf. For an application with a sample rate
of 1000 MHz, a 64-bit counter will not overflow for more than 500 years. See “Timers in
Asynchronous Tasks” on page 29-39 and “Control Memory Allocation for Time Counters” on page
69-10 for more information.

Elapsed Time Counters in Triggered Subsystems
Some blocks, such as the Discrete-Time Integrator block, perform computations requiring the elapsed
time (delta T) since the previous block execution. Blocks requiring elapsed time data must register
the requirement (see “Access Timers Programmatically” on page 27-4). A triggered subsystem then
allocates and maintains a single elapsed time counter if required. This timer functions at the
subsystem level, not at the individual block level. The timer is generated if the triggered subsystem
(or a unconditionally executed subsystem within the triggered subsystem) contains one or more
blocks requiring elapsed time data.

Note If you are using simplified initialization mode, elapsed time is reset on first execution after
becoming enabled, whether or not the subsystem is configured to reset on enable. For more
information, see “Underspecified initialization detection”.

See Also

More About
• “Access Timers Programmatically”
• “Generate Code for an Elapsed Time Counter”
• “Optimize Memory Usage for Time Counters”
• “Absolute Time Limitations”
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Access Timers Programmatically
In this section...
“About Timer APIs” on page 27-4
“C API for S-Functions” on page 27-4
“TLC API for Code Generation” on page 27-6

About Timer APIs
This topic describes APIs that let your S-functions take advantage of the efficiencies offered by
absolute and elapsed timers. SimStruct macros are provided for use in simulation, and TLC functions
are provided for inlined code generation. Note that

• To generate and use the new timers as described above, your S-functions must register the need
to use an absolute or elapsed timer by calling ssSetNeedAbsoluteTime or
ssSetNeedElapseTime in mdlInitializeSampleTime.

• Existing S-functions that read absolute time but do not register by using these macros continue to
operate as expected, but generate less efficient code.

C API for S-Functions
The SimStruct macros described in this topic provide access to absolute and elapsed timers for S-
functions during simulation.

In the functions below, the SimStruct *S argument is a pointer to the simstruct of the calling S-
function.

• void ssSetNeedAbsoluteTime(SimStruct *S, boolean b): if b is TRUE, registers that the
calling S-function requires absolute time data, and allocates an absolute time counter for the rate
at which the S-function executes (if such a counter has not already been allocated).

• int ssGetNeedAbsoluteTime(SimStruct *S): returns 1 if the S-function has registered that
it requires absolute time.

• double ssGetTaskTime(SimStruct *S, tid): read absolute time for a given task with task
identifier tid. ssGetTaskTime operates transparently, regardless of whether or not you use the
new timer features. ssGetTaskTime is documented in the SimStruct Functions chapter of the
Simulink documentation.

• void ssSetNeedElapseTime(SimStruct *S, boolean b): if b is TRUE, registers that the
calling S-function requires elapsed time data, and allocates an elapsed time counter for the
triggered subsystem in which the S-function executes (if such a counter has not already been
allocated). See also “Elapsed Time Counters in Triggered Subsystems” on page 27-3.

• int ssGetNeedElapseTime(SimStruct *S): returns 1 if the S-function has registered that it
requires elapsed time.

• void ssGetElapseTime(SimStruct *S, (double *)elapseTime): returns, to the location
pointed to by elapseTime, the value (as a double) of the elapsed time counter associated with
the S-function.

• void ssGetElapseTimeCounterDtype(SimStruct *S, (int *)dtype): returns the data
type of the elapsed time counter associated with the S-function to the location pointed to by
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dtype. This function is intended for use with the ssGetElapseTimeCounter function (see
below).

• void ssGetElapseResolution(SimStruct *S, (double *)resolution): returns the
resolution (that is, the sample time) of the elapsed time counter associated with the S-function to
the location pointed to by resolution. This function is intended for use with the
ssGetElapseTimeCounter function (see below).

• void ssGetElapseTimeCounter(SimStruct *S, (void *)elapseTime): This function is
provided for the use of blocks that require the elapsed time values for fixed-point computations.
ssGetElapseTimeCounter returns, to the location pointed to by elapseTime, the integer value
of the elapsed time counter associated with the S-function. If the counter size is 64 bits, the value
is returned as an array of two 32-bit words, with the low-order word stored at the lower address.

To determine how to access the returned counter value, obtain the data type of the counter by
calling ssGetElapseTimeCounterDtype, as in the following code:

int    *y_dtype;
ssGetElapseTimeCounterDtype(S, y_dtype);

 switch(*y_dtype) {
  case SS_DOUBLE_UINT32: 
      {
          uint32_T dataPtr[2];
          ssGetElapseTimeCounter(S, dataPtr);
      } 
      break;
  case SS_UINT32:
      {
         uint32_T dataPtr[1]; 
         ssGetElapseTimeCounter(S, dataPtr);
     }
      break;
  case SS_UINT16:
     {
          uint16_T dataPtr[1]; 
          ssGetElapseTimeCounter(S, dataPtr);
     }
      break;
  case SS_UINT8:
     {
         uint8_T dataPtr[1];
         ssGetElapseTimeCounter(S, dataPtr);
    }
     break;
  case SS_DOUBLE:
      {
         real_T dataPtr[1]; 
         ssGetElapseTimeCounter(S, dataPtr);
     }
      break;
  default:
    ssSetErrorStatus(S, "Invalid data type for elaspe time
        counter");
    break;
}
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If you want to use the actual elapsed time, issue a call to the ssGetElapseTime function to
access the elapsed time directly. You do not need to get the counter value and then calculate the
elapsed time.

double *y_elapseTime; 
.
.
.
ssGetElapseTime(S, elapseTime)

TLC API for Code Generation
The following TLC functions support elapsed time counters in generated code when you inline S-
functions by writing TLC scripts for them.

• LibGetTaskTimeFromTID(block): Generates code to read the absolute time for the task in
which block executes.

LibGetTaskTimeFromTID is documented with other sample time functions in the TLC Function
Library Reference pages of the Target Language Compiler documentation.

Note Do not use LibGetT for this purpose. LibGetT always reads the base rate (tid 0) timer. If
LibGetT is called for a block executing at a subrate, the wrong timer is read, causing serious
errors.

• LibGetElapseTime(system): Generates code to read the elapsed time counter for system.
(system is the parent system of the calling block.) See “Generate Code for an Elapsed Time
Counter” on page 27-7 for an example of code generated by this function.

• LibGetElapseTimeCounter(system): Generates code to read the integer value of the elapsed
time counter for system. (system is the parent system of the calling block.) This function should
be used in conjunction with LibGetElapseTimeCounterDtypeId and
LibGetElapseTimeResolution. (See the discussion of ssGetElapseTimeCounter above.)

• LibGetElapseTimeCounterDtypeId(system): Generates code that returns the data type of
the elapsed time counter for system. (system is the parent system of the calling block.)

• LibGetElapseTimeResolution(system): Generates code that returns the resolution of the
elapsed time counter for system. (system is the parent system of the calling block.)

See Also

More About
• “Absolute and Elapsed Time Computation”
• “Generate Code for an Elapsed Time Counter”
• “Absolute Time Limitations”
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Generate Code for an Elapsed Time Counter
This example shows a model that includes a triggered subsystem, Amplifier, consisting of a
Discrete-Time Integrator block that uses an elapsed time counter. The model ex_elapseTime is in
the folder matlab/help/toolbox/rtw/examples.

ex_elapseTime Model

Amplifier Subsystem

Code in the generated header file ex_elapseTime.h for the model uses 64 bits to implement the
timer for the base rate (clockTick0 and clockTickH0).

/*
 * Timing:
 * The following substructure contains information regarding
 * the timing information for the model.
 */
struct {
  time_T taskTime0;
  uint32_T clockTick0;
  uint32_T clockTickH0;
  time_T stepSize0;
  time_T tFinal;
  boolean_T stopRequestedFlag;
} Timing;

The code generator allocates storage for the previous-time value and elapsed-time value of the
Amplifier subsystem (Amplifier_PREV_T) in the D_Work(states) structure in
ex_elapsedTime.h.

/* Block states (auto storage) for system '<Root>' */
typedef struct { 
  real_T DiscreteTimeIntegrator_DSTATE;
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    /* '<S1>/Discrete-Time Integrator' */
  int32_T clockTickCounter;            
    /* '<Root>/Pulse Generator' */
  uint32_T Amplifier_ELAPS_T[2];       
    /* '<Root>/Amplifier' */
  uint32_T Amplifier_PREV_T[2];        
    /* '<Root>/Amplifier' */
    } DW_ex_elapseTime_T;

The elapsed time computation is performed as follows within the ex_elapseTime_step function:

/* ---
   Outputs for Triggered SubSystem:
      '<Root>/Amplifier' incorporates:
         TriggerPort: '<S1>/Trigger'
 --- */
 zcEvent = rt_ZCFcn(RISING_ZERO_CROSSING,
        &ex_elapseTime_PrevZCX.Amplifier_Trig_ZCE,           
        ((real_T)rtb_PulseGenerator));
    if (zcEvent != NO_ZCEVENT) {
   elapseT_H = ex_elapseTime_M->Timing.clockTickH0 -
        ex_elapseTime_DW.Amplifier_PREV_T[1];
      if (ex_elapseTime_DW.Amplifier_PREV_T[0] >
       ex_elapseTime_M->Timing.clockTick0) {
     elapseT_H--;
      }

   ex_elapseTime_DW.Amplifier_ELAPS_T[0] = 
      ex_elapseTime_M->Timing.clockTick0 
      - ex_elapseTime_DW.Amplifier_PREV_T[0];
   ex_elapseTime_DW.Amplifier_PREV_T[0] = 
      ex_elapseTime_M->Timing.clockTick0;
   ex_elapseTime_DW.Amplifier_ELAPS_T[1] = 
      elapseT_H;
   ex_elapseTime_DW.Amplifier_PREV_T[1] = 
      ex_elapseTime_M->Timing.clockTickH0;

As shown above, the elapsed time is maintained as a state of the triggered subsystem. The Discrete-
Time Integrator block finally performs its output and update computations using the elapsed time.

/* ---
DiscreteIntegrator: '<S1>/Discrete-Time Integrator' 
--- */
OUTPUT = ex_elapseTime_DW.DiscreteTimeIntegrator_DSTATE;

/* --- 
Update for DiscreteIntegrator: 
   '<S1>/Discrete-Time Integrator' incorporates:
      Constant: '<Root>/Constant'
--- */
   ex_elapseTime_DW.DiscreteTimeIntegrator_DSTATE += 0.3 * (real_T)
     ex_elapseTime_DW.Amplifier_ELAPS_T[0] * 1.5;
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See Also

More About
• “Absolute and Elapsed Time Computation”
• “Absolute Time Limitations”
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Absolute Time Limitations
Absolute time is the time that has elapsed from the beginning of program execution to the present
time, as distinct from elapsed time, the interval between two events. See “Absolute and Elapsed Time
Computation” on page 27-2 for more information.

When you design an application that is intended to run indefinitely, you must take care when logging
time values, or using charts or blocks that depend on absolute time. If the value of time reaches the
largest value that can be represented by the data type used by the timer to store time, the timer
overflows and the logged time or block output is incorrect.

If your target uses rtModel, you can avoid timer overflow by specifying a value for model
configuration parameter Application lifespan. See “Integer Timers in Generated Code” on page 27-
3 for more information.

The following limitations apply to absolute time:

• If you log time values by selecting model configuration parameter Time, your model uses absolute
time.

• Every Stateflow chart that uses time is dependent on absolute time. The only way to eliminate the
dependency is to change the Stateflow chart to not use time.

• The following Simulink blocks depend on absolute time:

• Backlash
• Chirp Signal
• Clock
• Derivative
• Digital Clock
• Discrete-Time Integrator (only when used in triggered subsystems)
• From File
• From Workspace
• Pulse Generator
• Ramp
• Rate Limiter
• Repeating Sequence
• Signal Generator
• Sine Wave (only when the Sine type parameter is set to Time-based)
• Step
• To File
• To Workspace (only when logging to StructureWithTime format)
• Transport Delay
• Variable Transport Delay

In addition to the Simulink blocks above, blocks in other blocksets may depend on absolute time.
See the documentation for the blocksets that you use.
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See Also

More About
• “Absolute and Elapsed Time Computation”
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Time-Based Scheduling and Code Generation

In this section...
“Sample Time Considerations” on page 28-2
“Tasking Modes” on page 28-2
“Model Execution and Rate Transitions” on page 28-3
“Execution During Simulink Model Simulation” on page 28-4
“Model Execution in Real Time” on page 28-4
“Single-Tasking Versus Multitasking Operation” on page 28-4

Sample Time Considerations
Simulink models run at one or more sample times. The Simulink product provides considerable
flexibility in building multirate systems, that is, systems with more than one sample time. However,
this same flexibility also allows you to construct models for which the code generator cannot generate
real-time code for execution in a multitasking environment. To make multirate models operate as
expected in real time (that is, to give the right answers), you sometimes must modify your model or
instruct the Simulink engine to modify the model for you. In general, the modifications involve
placing Rate Transition blocks between blocks that have unequal sample times. The following
sections discuss issues you must address to use a multirate model in a multitasking environment. For
a comprehensive discussion of sample times, including rate transitions, see “What Is Sample Time?”,
“Sample Times in Subsystems”, “Sample Times in Systems”, “Resolve Rate Transitions”, and
associated topics.

Tasking Modes
There are two execution modes for a fixed-step model: single-tasking and multitasking. These modes
are available only for fixed-step solvers. To select an execution mode, select model configuration
parameter Treat each discrete rate as a separate task. When you select this parameter,
multitasking execution is applied for a multirate model. When you clear this parameter, single-tasking
execution is applied.

Note A model that is multirate and uses multitasking cannot reference a multirate model that uses
single-tasking.

Execution of models in a real-time system can be done with the aid of a real-time operating system, or
it can be done on bare-metal target hardware, where the model runs in the context of an interrupt
service routine (ISR).

The fact that a system (such as The Open Group UNIX or Microsoft Windows systems) is multitasking
does not imply that your program can execute in real time. This is because the program might not
preempt other processes when required.

In operating systems (such as PC-DOS) where only one process can exist at a given time, an interrupt
service routine (ISR) must perform the steps of saving the processor context, executing the model
code, collecting data, and restoring the processor context.
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Other operating systems, such as POSIX-compliant ones, provide automatic context switching and
task scheduling. This simplifies the operations performed by the ISR. In this case, the ISR simply
enables the model execution task, which is normally blocked. The next figure illustrates this
difference.

Model Execution and Rate Transitions
To generate code that executes as expected in real time, you (or the Simulink engine) might need to
identify and handle sample rate transitions within the model. In multitasking mode, by default the
Simulink engine flags errors during simulation if the model contains invalid rate transitions, although
you can use the model configuration parameter Multitask rate transition to alter this behavior.
Parameter Single task rate transition is available for the same purpose for single-tasking mode.

To avoid raising rate transition errors, insert Rate Transition blocks between tasks. You can request
that the Simulink engine handle rate transitions automatically by inserting hidden Rate Transition
blocks. See “Automatic Rate Transition” on page 28-19 for an explanation of this option.

To understand such problems, first consider how Simulink simulations differ from real-time programs.
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Execution During Simulink Model Simulation
Before the Simulink engine simulates a model, it orders the blocks based upon their topological
dependencies. This includes expanding virtual subsystems into the individual blocks they contain and
flattening the entire model into a single list. Once this step is complete, each block is executed in
order.

The key to this process is the ordering of blocks. A block whose output is directly dependent on its
input (that is, a block with direct feedthrough) cannot execute until the block driving its input
executes.

Some blocks set their outputs based on values acquired in a previous time step or from initial
conditions specified as a block parameter. The output of such a block is determined by a value stored
in memory, which can be updated independently of its input. During simulation, computations are
performed prior to advancing the variable corresponding to time. This results in computations
occurring instantaneously (that is, no computational delay).

Model Execution in Real Time
A real-time program differs from a Simulink simulation in that the program must execute the model
code synchronously with real time. Every calculation results in some computational delay. This means
the sample intervals cannot be shortened or lengthened (as they can be in a Simulink simulation),
which leads to less efficient execution.

Consider the following timing figure.

Note the processing inefficiency in the sample interval t1. That interval cannot be compressed to
increase execution speed because, by definition, sample times are clocked in real time.

You can circumvent this potential inefficiency by using the multitasking mode. The multitasking mode
defines tasks with different priorities to execute parts of the model code that have different sample
rates.

See “Multitasking and Pseudomultitasking Modes” on page 28-9 for a description of how this
works. It is important to understand that section before proceeding here.

Single-Tasking Versus Multitasking Operation
Single-tasking programs require longer sample intervals, because all computations must be executed
within each clock period. This can result in inefficient use of available CPU time, as shown in the
previous figure.

Multitasking mode can improve the efficiency of your program if the model is large and has many
blocks executing at each rate.
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However, if your model is dominated by a single rate, and only a few blocks execute at a slower rate,
multitasking can actually degrade performance. In such a model, the overhead incurred in task
switching can be greater than the time required to execute the slower blocks. In this case, it is more
efficient to execute all blocks at the dominant rate.

If you have a model that can benefit from multitasking execution, you might need to modify your
model by adding Rate Transition blocks (or instruct the Simulink engine to do so) to generate
expected results.

For more information about the two modes of execution and examples, see “Modeling for Single-
Tasking Execution” on page 28-6 and “Modeling for Multitasking Execution” on page 28-9.

See Also

More About
• “What Is Sample Time?”
• “Sample Times in Subsystems”
• “Sample Times in Systems”
• “Configure Time-Based Scheduling”
• “Sample Times in Subsystems”
• “Sample Times in Systems”
• “Resolve Rate Transitions”
• “Handle Rate Transitions”
• “Time-Based Scheduling and Code Generation”
• “Modeling for Single-Tasking Execution”
• “Modeling for Multitasking Execution”
• “Time-Based Scheduling Example Models”

 Time-Based Scheduling and Code Generation

28-5



Modeling for Single-Tasking Execution

Single-Tasking Mode
You can execute model code in a strictly single-tasking manner. While this mode is less efficient with
regard to execution speed, in certain situations, it can simplify your model.

In single-tasking mode, the base sample rate must define a time interval that is long enough to allow
the execution of all blocks within that interval.

The next figure illustrates the inefficiency inherent in single-tasking execution.

Single-tasking system execution requires a base sample rate that is long enough to execute one step
through the entire model.

Build a Program for Single-Tasking Execution
To use single-tasking execution, clear model configuration parameter Treat each discrete rate as a
separate task. If you select the parameter, single-tasking mode is used in the following cases:

• If your model contains one sample time
• If your model contains a continuous and a discrete sample time and the fixed step size is equal to

the discrete sample time

Single-Tasking Execution
This example examines how a simple multirate model executes in both real time and simulation, using
a fixed-step solver. It considers operation in both single-tasking and multitasking modes, as
determined by setting model configuration parameter Treat each discrete rate as a separate task.

The example model is shown in the next figure. The discussion refers to the six blocks of the model as
A through F, as labeled in the block diagram.

The execution order of the blocks (indicated in the upper right of each block) has been forced into the
order shown by assigning higher priorities to blocks F, E, and D. The ordering shown is one possible
valid execution ordering for this model. For more information, see “Simulation Phases in Dynamic
Systems”.

The execution order is determined by data dependencies between blocks. In a real-time system, the
execution order determines the order in which blocks execute within a given time interval or task.
This discussion treats the model's execution order as a given, because it is concerned with the
allocation of block computations to tasks, and the scheduling of task execution.
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Note The discussion and timing diagrams in this section are based on the assumption that the Rate
Transition blocks are used in the default (protected) mode, with block parameters Ensure data
integrity during data transfer and Ensure deterministic data transfer (maximum delay)
selected

This example considers the execution of the above model when model configuration parameter Treat
each discrete rate as a separate task is cleared, which indicates the single-tasking mode.

In a single-tasking system, if you select model configuration parameter Block reduction, fast-to-slow
Rate Transition blocks are optimized out of the model. The default case is shown (parameter Block
reduction selected), so block B does not appear in the timing diagrams in this section. For more
information, see “Block reduction”.

The following table shows, for each block in the model, the execution order, sample time, and
whether the block has an output or update computation. Block A does not have discrete states, and
accordingly does not have an update computation.

Execution Order and Sample Times (Single-Tasking)

Blocks
(in Execution Order)

Sample Time
(in Seconds)

Output Update

E 0.1 Y Y
F 0.1 Y Y
D 1 Y Y
A 0.1 Y N
C 1 Y Y

Real-Time Single-Tasking Execution

The next figure shows the scheduling of computations when the generated code is deployed in a real-
time system. The generated program is shown running in real time, under control of interrupts from a
10 Hz timer.
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At time 0.0, 1.0, and every second thereafter, both the slow and fast blocks execute their output
computations; this is followed by update computations for blocks that have states. Within a given time
interval, output and update computations are sequenced in block execution order.

The fast blocks execute on every tick, at intervals of 0.1 second. Output computations are followed by
update computations.

The system spends some portion of each time interval (labeled “wait”) idling. During the intervals
when only the fast blocks execute, a larger portion of the interval is spent idling. This illustrates an
inherent inefficiency of single-tasking mode.

Simulated Single-Tasking Execution

The next figure shows the execution of the model during the Simulink simulation loop.

Because time is simulated, the placement of ticks represents the iterations of the simulation loop.
Blocks execute in exactly the same order as in the previous figure, but without the constraint of a
real-time clock. Therefore there is no idle time between simulated sample periods.

See Also

More About
• “Time-Based Scheduling and Code Generation”
• “Configure Time-Based Scheduling”
• “Time-Based Scheduling Example Models”

28 Time-Based Scheduling in Simulink Coder

28-8



Modeling for Multitasking Execution

Multitasking and Pseudomultitasking Modes
When periodic tasks execute in a multitasking mode, by default the blocks with the fastest sample
rates are executed by the task with the highest priority, the next fastest blocks are executed by a task
with the next higher priority, and so on. Time available in between the processing of high-priority
tasks is used for processing lower priority tasks. This results in efficient program execution.

Where tasks are asynchronous rather than periodic, there may not necessarily be a relationship
between sample rates and task priorities; the task with the highest priority need not have the fastest
sample rate. You specify asynchronous task priorities using Async Interrupt and Task Sync blocks.
You can switch the sense of what priority numbers mean by selecting or clearing model configuration
parameter Higher priority value indicates higher task priority.

In multitasking environments (that is, under a real-time operating system), you can define separate
tasks and assign them priorities. For bare-metal target hardware (that is, no real-time operating
system present), you cannot create separate tasks. However, generated application modules
implement what is effectively a multitasking execution scheme using overlapped interrupts,
accompanied by programmatic context switching.

This means an interrupt can occur while another interrupt is currently in progress. When this
happens, the current interrupt is preempted, the floating-point unit (FPU) context is saved, and the
higher priority interrupt executes its higher priority (that is, faster sample rate) code. Once complete,
control is returned to the preempted ISR.

The next figures illustrate how timing of tasks in multirate systems are handled by the code generator
in multitasking, pseudomultitasking, and single-tasking environments.
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The next figure shows how overlapped interrupts are used to implement pseudomultitasking. In this
case, Interrupt 0 does not return until after Interrupts 1, 2, and 3.

28 Time-Based Scheduling in Simulink Coder

28-10



Build a Program for Multitasking Execution
To use multitasking execution, select model configuration parameter Treat each discrete rate as a
separate task. This parameter is active only if you set Solver type to Fixed-step. Auto mode
results in a multitasking environment if your model has two or more different sample times. A model
with a continuous and a discrete sample time runs in single-tasking mode if the fixed-step size is
equal to the discrete sample time.

Execute Multitasking Models
In cases where the continuous part of a model executes at a rate that is different from the discrete
part, or a model has blocks with different sample rates, the Simulink engine assigns each block a task
identifier (tid) to associate the block with the task that executes at the block's sample rate.

You set sample rates and their constraints on the Solver pane of the Model Configuration Parameters
dialog box. To generate code, select Fixed-step for the solver type. Certain restrictions apply to the
sample rates that you can use:

• The sample rate of a block must be an integer multiple of the base (that is, the fastest) sample
period.

• When you set model configuration parameter Periodic sample time constraint to
unconstrained, the base sample period is determined by the setting of parameter Fixed step
size.

• When you set parameter Periodic sample time constraint to Specified, the base rate fixed-
step size is the first element of the sample time matrix that you specify for parameter Sample
time properties. The Solver pane from the example model rtwdemo_mrmtbb shows an example.
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• Continuous blocks execute by using an integration algorithm that runs at the base sample rate.
The base sample period is the greatest common denominator of rates in the model only when you
set model configuration parameter Periodic sample time constraint to Unconstrained and
parameter Fixed step size to Auto.

• The continuous and discrete parts of the model can execute at different rates only if the discrete
part is executed at the same or a slower rate than the continuous part and is an integer multiple of
the base sample rate.

Multitasking Execution
This example examines how a simple multirate model executes in both real time and simulation, using
a fixed-step solver. It considers operation in both single-tasking and multitasking modes, as
determined by setting model configuration parameter Treat each discrete rate as a separate task.

The example model is shown in the next figure. The discussion refers to the six blocks of the model as
A through F, as labeled in the block diagram.

The execution order of the blocks (indicated in the upper right of each block) has been forced into the
order shown by assigning higher priorities to blocks F, E, and D. The ordering shown is one possible
valid execution ordering for this model. For more information, see “Simulation Phases in Dynamic
Systems”.
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The execution order is determined by data dependencies between blocks. In a real-time system, the
execution order determines the order in which blocks execute within a given time interval or task.
This discussion treats the model's execution order as a given, because it is concerned with the
allocation of block computations to tasks, and the scheduling of task execution.

Note The discussion and timing diagrams in this section are based on the assumption that the Rate
Transition blocks are used in the default (protected) mode, with block parameters Ensure data
integrity during data transfer and Ensure deterministic data transfer (maximum delay)
selected

This example considers the execution of the preceding model when model configuration parameter
Tasking mode is set to MultiTasking. Block computations are executed under two tasks,
prioritized by rate:

• The slower task, which gets the lower priority, is scheduled to run every second. This is called the
1 second task.

• The faster task, which gets higher priority, is scheduled to run 10 times per second. This is called
the 0.1 second task. The 0.1 second task can preempt the 1 second task.

The following table shows, for each block in the model, the execution order, the task under which the
block runs, and whether the block has an output or update computation. Blocks A and B do not have
discrete states, and accordingly do not have an update computation.
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Task Allocation of Blocks in Multitasking Execution

Blocks
(in Execution Order)

Task Output Update

E 0.1 second task Y Y
F 0.1 second task Y Y
D The Rate Transition block uses port-based

sample times.
Output runs at the output port sample time
under 0.1 second task.
Update runs at input port sample time under 1
second task.
For more information on port-based sample
times, see “Referenced Model Sample Times”.

Y Y

A 0.1 second task Y N
B The Rate Transition block uses port-based

sample times.
Output runs at the output port sample time
under 0.1 second task.
For more information on port-based sample
times, see “Referenced Model Sample Times”.

Y N

C 1 second task Y Y

Real-Time Multitasking Execution

The next figure shows the scheduling of computations in MultiTasking solver mode when the
generated code is deployed in a real-time system. The generated program is shown running in real
time, as two tasks under control of interrupts from a 10 Hz timer.
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Simulated Multitasking Execution

The next figure shows the Simulink execution of the same model, in MultiTasking solver mode. In
this case, the Simulink engine runs the blocks in one thread of execution, simulating multitasking. No
preemption occurs.

See Also

More About
• “Time-Based Scheduling and Code Generation”
• “Sample Times in Subsystems”
• “Sample Times in Systems”
• “Configure Time-Based Scheduling”
• “Resolve Rate Transitions”
• “Handle Rate Transitions”
• “Time-Based Scheduling Example Models”

 Modeling for Multitasking Execution

28-15



Handle Rate Transitions

Rate Transitions
Two periodic sample rate transitions can exist within a model:

• A faster block driving a slower block
• A slower block driving a faster block

The following sections concern models with periodic sample times with zero offset only. Other
considerations apply to multirate models that involve asynchronous tasks. For details on how to
generate code for asynchronous multitasking, see “Asynchronous Support”.

In multitasking and pseudomultitasking systems, differing sample rates can cause blocks to be
executed in the wrong order. To prevent possible errors in calculated data, you must control model
execution at these transitions. When connecting faster and slower blocks, you or the Simulink engine
must add Rate Transition blocks between them. Fast-to-slow transitions are illustrated in the next
figure.

Slow-to-fast transitions are illustrated in the next figure.
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Note Although the Rate Transition block offers a superset of the capabilities of the Unit Delay block
(for slow-to-fast transitions) and the Zero-Order Hold block (for fast-to-slow transitions), you should
use the Rate Transition block instead of these blocks.

Data Transfer Problems
Rate Transition blocks deal with issues of data integrity and determinism associated with data
transfer between blocks running at different rates.

• Data integrity: A problem of data integrity exists when the input to a block changes during the
execution of that block. Data integrity problems can be caused by preemption.

Consider the following scenario:

• A faster block supplies the input to a slower block.
• The slower block reads an input value V1 from the faster block and begins computations using

that value.
• The computations are preempted by another execution of the faster block, which computes a

new output value V2.
• A data integrity problem now arises: when the slower block resumes execution, it continues its

computations, now using the “new” input value V2.

Such a data transfer is called unprotected. “Faster to Slower Transitions in Real Time” on page
28-22 shows an unprotected data transfer.

In a protected data transfer, the output V1 of the faster block is held until the slower block finishes
executing.

• Deterministic versus nondeterministic data transfer: In a deterministic data transfer, the timing of
the data transfer is completely predictable, as determined by the sample rates of the blocks.

The timing of a nondeterministic data transfer depends on the availability of data, the sample
rates of the blocks, and the time at which the receiving block begins to execute relative to the
driving block.

You can use the Rate Transition block to protect data transfers in your application and make them
deterministic. These characteristics are considered desirable in most applications. However, the Rate
Transition block supports flexible options that allow you to compromise data integrity and
determinism in favor of lower latency. The next section summarizes these options.

Data Transfer Assumptions
When processing data transfers between tasks, the code generator makes these assumptions:

• Data transitions occur between a single reading task and a single writing task.
• A read or write of a byte-sized variable is atomic.
• When two tasks interact through a data transition, only one of them can preempt the other.
• For periodic tasks, the faster rate task has higher priority than the slower rate task; the faster rate

task preempts the slower rate task.
• All tasks run on a single processor. Time slicing is not allowed.
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• Processes do not crash or restart (especially while data is transferred between tasks).

Rate Transition Block Options
Several parameters of the Rate Transition block are relevant to its use in code generation for real-
time execution, as discussed below. For a complete block description, see Rate Transition.

The Rate Transition block handles periodic (fast to slow and slow to fast) and asynchronous
transitions. When inserted between two blocks of differing sample rates, the Rate Transition block
automatically configures its input and output sample rates for the type of transition; you do not need
to specify whether a transition is slow-to-fast or fast-to-slow (low-to-high or high-to-low priorities for
asynchronous tasks).

The critical decision you must make in configuring a Rate Transition block is the choice of data
transfer mechanism to be used between the two rates. Your choice is dictated by considerations of
safety, memory usage, and performance. As the Rate Transition block parameter dialog box in the
next figure shows, the data transfer mechanism is controlled by two options.

• Ensure data integrity during data transfer: When you select this parameter, data transferred
between rates maintains its integrity (the data transfer is protected). When you clear this
parameter, data might not maintain its integrity (the data transfer is unprotected). By default,
parameter Ensure data integrity during data transfer is selected.

• Ensure deterministic data transfer (maximum delay): This parameter is supported for
periodic tasks with an offset of zero and fast and slow rates that are multiples of each other. When
this parameter is selected, the Rate Transition block behaves like a Zero-Order Hold block (for
fast to slow transitions) or a Unit Delay block (for slow to fast transitions). The Rate Transition
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block controls the timing of data transfer in a completely predictable way. When this parameter is
cleared, the data transfer is nondeterministic. By default, Ensure deterministic data transfer
(maximum delay) is selected for transitions between periodic rates with an offset of zero; for
asynchronous transitions, it cannot be selected.

The Rate Transition block offers three modes of operation with respect to data transfer. In order of
level of safety:

• Protected/Deterministic (default): This is the safest mode. The drawback of this mode is that it
introduces deterministic latency into the system for the case of slow-to-fast periodic rate
transitions. For that case, the latency introduced by the Rate Transition block is one sample
period of the slower task. For the case of fast-to-slow periodic rate transitions, the Rate Transition
block does not introduce additional latency.

• Protected/NonDeterministic: In this mode, for slow-to-fast periodic rate transitions, data
integrity is protected by double-buffering data transferred between rates. For fast-to-slow periodic
rate transitions, a semaphore flag is used. The blocks downstream from the Rate Transition block
use the latest available data from the block that drives the Rate Transition block. Maximum
latency is less than or equal to one sample period of the faster task.

The drawbacks of this mode are its nondeterministic timing. The advantage of this mode is its low
latency.

• Unprotected/NonDeterministic: This mode is not recommended for mission-critical
applications. The latency of this mode is the same as for Protected/NonDeterministic mode, but
memory requirements are reduced since neither double-buffering nor semaphores are required.
That is, the Rate Transition block does nothing in this mode other than to pass signals through; it
simply exists to notify you that a rate transition exists (and can cause generated code to compute
incorrect answers). Selecting this mode, however, generates the least amount of code.

Note In unprotected mode (Ensure data integrity during data transfer is selected), the Rate
Transition block does nothing other than allow the rate transition to exist in the model.

Rate Transition Blocks and Continuous Time

The sample time at the output port of a Rate Transition block can only be discrete or fixed in minor
time step. This means that when a Rate Transition block inherits continuous sample time from its
destination block, it treats the inherited sample time as Fixed in Minor Time Step. Therefore, the
output function of the Rate Transition block runs only at major time steps. If the destination block
sample time is continuous, Rate Transition block output sample time is the base rate sample time (if
solver is fixed-step), or zero-order-hold-continuous sample time (if solver is variable-step).

Automatic Rate Transition
The Simulink engine can detect mismatched rate transitions in a multitasking model during an
update diagram and automatically insert Rate Transition blocks to handle them. To enable this, select
model configuration parameter Automatically handle rate transition for data transfer. By
default, this parameter is cleared. When you select this parameter:

• Simulink handles transitions between periodic sample times and asynchronous tasks.
• Simulink inserts hidden Rate Transition blocks in the block diagram.
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• The code generator produces code for the Rate Transition blocks that were automatically inserted.
This code is identical to the code generated for Rate Transition blocks that were inserted
manually.

• Automatically inserted Rate Transition blocks operate in protected mode for periodic tasks and
asynchronous tasks. You cannot alter this behavior. For periodic tasks, automatically inserted Rate
Transition blocks operate with the level of determinism specified by model configuration
parameter Deterministic data transfer. The default setting is Whenever possible, which
enables determinism for data transfers between periodic sample-times that are related by an
integer multiple. For more information, see “Deterministic data transfer”. To use other modes, you
must insert Rate Transition blocks and set their modes manually.

For example, in this model, SineWave2 has a sample time of 2, and SineWave3 has a sample time of 3.

When you select model configuration parameter Automatically handle rate transition for data
transfer, Simulink inserts a Rate Transition block between each Sine Wave block and the Product
block. The inserted blocks have the parameter values to reconcile the Sine Wave block sample times.

If the input port and output port data sample rates in a model are not multiples of each other,
Simulink inserts a Rate Transition block whose sample rate is the greatest common divisor (GCD) of
the two rates. If no other block in the model contains this new rate, an error occurs during
simulation. In this case, you must insert a Rate Transition block manually.

Visualize Inserted Rate Transition Blocks
When you select model configuration parameter Automatically handle rate transition for data
transfer, Simulink inserts Rate Transition blocks in the paths that have mismatched transition rates.
These blocks are hidden by default. To visualize the inserted blocks, update the diagram. Badge
labels appear in the model and indicate where Simulink inserted Rate Transition blocks during the
compilation phase. For example, in this model, three Rate Transition blocks were inserted between
the two Sine Wave blocks and the Multiplexer and Integrator when the model compiled. The ZOH and
DbBuf badge labels indicate these blocks.
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You can show or hide badge labels. Open the Debug tab. In the Diagnostics section of the
Information Overlays/Sample Time gallery select or clear Automatic Rate Transitions.

To configure the hidden Rate Transition blocks so that the blocks are visible, right-click a badge label
and click Insert rate transition block.

When you make hidden Rate Transition blocks visible:

• You can see the type of Rate Transition block inserted and the location of the block in the model.
• You can set the block parameter Initial Conditions.
• You can change block parameter settings for rate transfer.

Validate the changes to your model by updating your diagram.
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Displaying inserted Rate Transition blocks is not compatible with export-function models.

To learn more about types of Rate Transition blocks, see Rate Transition.
To learn more about the types of Rate Transition blocks, see Rate Transition.

Periodic Sample Rate Transitions
These sections describe cases in which Rate Transition blocks are required for periodic sample rate
transitions. The discussion and timing diagrams in these sections are based on the assumption that
the Rate Transition block is used in its default (protected/deterministic) mode. Model configuration
parameters Ensure data integrity during data transfer and Ensure deterministic data transfer
(maximum delay) are selected. These are the settings used for automatically inserted Rate
Transition blocks.

Faster to Slower Transitions in a Simulink Model

In a model where a faster block drives a slower block having direct feedthrough, the outputs of the
faster block are computed first. In simulation intervals where the slower block does not execute, the
simulation progresses more rapidly because there are fewer blocks to execute. The next figure
illustrates this situation.

A Simulink simulation does not execute in real time, which means that it is not bound by real-time
constraints. The simulation waits for, or moves ahead to, whatever tasks are required to complete
simulation flow. The actual time interval between sample time steps can vary.

Faster to Slower Transitions in Real Time

In models where a faster block drives a slower block, you must compensate for the fact that execution
of the slower block might span more than one execution period of the faster block. This means that
the outputs of the faster block can change before the slower block has finished computing its outputs.
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The next figure shows a situation in which this problem arises (T = sample time). Note that lower
priority tasks are preempted by higher priority tasks before completion.

In the above figure, the faster block executes a second time before the slower block has completed
execution. This can cause unpredictable results because the input data to the slow task is changing.
Data might not maintain its integrity in this situation.

To avoid this situation, the Simulink engine must hold the outputs of the 1 second (faster) block until
the 2 second (slower) block finishes executing. The way to accomplish this is by inserting a Rate
Transition block between the 1 second and 2 second blocks. The input to the slower block does not
change during its execution, maintaining data integrity.

It is assumed that the Rate Transition block is used in its default (protected/deterministic) mode.

The Rate Transition block executes at the sample rate of the slower block, but with the priority of the
faster block.
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When you add a Rate Transition block, the block executes before the 2 second block (its priority is
higher) and its output value is held constant while the 2 second block executes (it executes at the
slower sample rate).

Slower to Faster Transitions in a Simulink Model

In a model where a slower block drives a faster block, the Simulink engine again computes the output
of the driving block first. During sample intervals where only the faster block executes, the simulation
progresses more rapidly.

The next figure shows the execution sequence.

As you can see from the preceding figures, the Simulink engine can simulate models with multiple
sample rates in an efficient manner. However, a Simulink simulation does not operate in real time.

Slower to Faster Transitions in Real Time

In models where a slower block drives a faster block, the generated code assigns the faster block a
higher priority than the slower block. This means the faster block is executed before the slower block,
which requires special care to avoid incorrect results.

This timing diagram illustrates two problems:

• Execution of the slower block is split over more than one faster block interval. In this case the
faster task executes a second time before the slower task has completed execution. This means
the inputs to the faster task can have incorrect values some of the time.

• The faster block executes before the slower block (which is backward from the way a Simulink
simulation operates). In this case, the 1 second block executes first; but the inputs to the faster
task have not been computed. This can cause unpredictable results.
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To eliminate these problems, you must insert a Rate Transition block between the slower and faster
blocks.

It is assumed that the Rate Transition block is used in its default (protected/deterministic) mode.

The next figure shows the timing sequence that results with the added Rate Transition block.

Three key points about transitions in this diagram (refer to circled numbers):

1 The Rate Transition block output runs in the 1 second task, but at a slower rate (2 seconds). The
output of the Rate Transition block feeds the 1 second task blocks.

2 The Rate Transition update uses the output of the 2 second task to update its internal state.
3 The Rate Transition output in the 1 second task uses the state of the Rate Transition that was

updated in the 2 second task.

The first problem is alleviated because the Rate Transition block is updating at a slower rate and at
the priority of the slower block. The input to the Rate Transition block (which is the output of the
slower block) is read after the slower block completes executing.

The second problem is alleviated because the Rate Transition block executes at a slower rate and its
output does not change during the computation of the faster block it is driving. The output portion of
a Rate Transition block is executed at the sample rate of the slower block, but with the priority of the
faster block. Since the Rate Transition block drives the faster block and has effectively the same
priority, it is executed before the faster block.

Note This use of the Rate Transition block changes the model. The output of the slower block is now
delayed by one time step compared to the output without a Rate Transition block.
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Protect Data Integrity with volatile Keyword
When you select model configuration parameter Ensure data integrity during data transfer, the
code generated for a Rate Transition block defines global buffers and semaphores and uses them to
protect the integrity of the transferred data.

Particularly for a multitasking application, the tasks (rates) involved in a data transfer can write to
the transferred data, buffers, and semaphores at times that your compiler cannot anticipate. To
prevent your compiler from optimizing the assembly code in a manner that compromises the integrity
of the transferred data, the code generator applies the keyword volatile to the buffers and
semaphores. The code generator does not apply volatile to the global variable that represents the
transferred data because the volatile buffers and semaphores typically offer enough protection.

With Embedded Coder, you can explicitly apply volatile to the transferred data by applying the
built-in custom storage class Volatile to the input of the Rate Transition block. For example, you
can use this technique to help protect the integrity of data that your external code shares with the
generated code.

Alternatively, to protect data that your external code shares with the generated code, you can write
your own C functions that read and write the data in a protected manner. Then, you can apply the
custom storage class GetSet to the data in the model, which causes the generated code to call your
functions instead of directly accessing the data.

For more information about applying volatile, see “Protect Global Data with const and volatile
Type Qualifiers” on page 43-13. For more information about GetSet, see “Access Data Through
Functions with Storage Class GetSet” on page 38-26.

Separate Rate Transition Block Code and Data from Algorithm Code
and Data
You can specify whether the code generator inlines code and data it produces for Rate Transition
blocks with model code or places the code and data in separate functions that the model code calls.
You control this by selecting the Rate Transition block code parameter. Separating Rate Transition
block code and data from algorithm code and data enables you to independently analyze, optimize,
and test Rate Transition block and algorithm code. By default, Rate Transition block code is set inline
with algorithm code and data. You can separate the code and data so that the generated code
contains separate get and set functions that the model_step functions call and a dedicated
structure for state data. The generated code also contains separate start and initialize
functions that the model_initialize function calls.

Example Model

Open the example model rtwdemo_ratetrans. This multirate, multitasking model contains several
Rate Transition blocks operating at different modes.

open_system('rtwdemo_ratetrans');
set_param('rtwdemo_ratetrans','SystemTargetFile','ert.tlc');
set_param('rtwdemo_ratetrans','GenerateComments', 'Off');

Separate Code for Rate Transition blocks

In the Configuration Parameters dialog box, the Rate Transition block code parameter is set to
Function. Generate code for the model. The code is in the files rtwdemo_ratetrans.c and
rtwdemo_ratetrans.h.
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currentDir = pwd;
[~,cgDir] = rtwdemodir();
slbuild('rtwdemo_ratetrans');

### Starting build procedure for: rtwdemo_ratetrans
### Successful completion of build procedure for: rtwdemo_ratetrans

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                                    
==================================================================================================
rtwdemo_ratetrans  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.153s

hfile=fullfile(cgDir, 'rtwdemo_ratetrans_ert_rtw','rtwdemo_ratetrans.h');
rtwdemodbtype(hfile,'typedef struct {','} DW;', 1, 1);

typedef struct {
  real_T OutportBufferForOut3[20];
  real_T Integrator1_DSTATE[20];
  real_T Integrator2_DSTATE[20];
  real_T Integrator3_DSTATE[20];
  real_T Integrator1_PREV_U[20];
  real_T Integrator2_PREV_U[20];
  real_T Integrator3_PREV_U[20];
  uint32_T Algorithm_PREV_T;
  struct {
    uint_T Algorithm_RESET_ELAPS_T:1;
  } bitsForTID1;

  uint8_T Integrator1_SYSTEM_ENABLE;
  uint8_T Integrator2_SYSTEM_ENABLE;
  uint8_T Integrator3_SYSTEM_ENABLE;
} DW;

For Rate Transition blocks, the state data is not in the global state structure,
DW_rtwdemo_ratetrans_T. This data is in its own structure in the file
rtwdemo_ratetrans_rtb.h.

This code is in the file rtwdemo_ratetrans.c.

cfile=fullfile(cgDir, 'rtwdemo_ratetrans_ert_rtw','rtwdemo_ratetrans.c');
rtwdemodbtype(cfile,'void rtwdemo_ratetrans_step0','void rtwdemo_ratetrans_terminate(void)', 1, 0);

void rtwdemo_ratetrans_step0(void)
{
  (rtM->Timing.RateInteraction.TID0_1)++;
  if ((rtM->Timing.RateInteraction.TID0_1) > 1) {
    rtM->Timing.RateInteraction.TID0_1 = 0;
  }

  rtwdemo_rate_DetAndIntegS2F_get(rtY.Out1);
  rtwdemo_ratetr_IntegOnlyS2F_get(rtY.Out2);
  memcpy(&rtY.Out3[0], &rtDW.OutportBufferForOut3[0], 20U * sizeof(real_T));
  rtwdemo_rate_DetAndIntegF2S_set(rtU.In1);
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  rtwdemo_ratetr_IntegOnlyF2S_set(rtU.In2);
}

void rtwdemo_ratetrans_step1(void)
{
  real_T rtb_DetAndIntegF2S[20];
  real_T rtb_IntegOnlyF2S[20];
  real_T tmp;
  int32_T i;
  uint32_T Algorithm_ELAPS_T;
  rtwdemo_rate_DetAndIntegF2S_get(rtb_DetAndIntegF2S);
  rtwdemo_ratetr_IntegOnlyF2S_get(rtb_IntegOnlyF2S);
  if (rtDW.bitsForTID1.Algorithm_RESET_ELAPS_T) {
    Algorithm_ELAPS_T = 0U;
  } else {
    Algorithm_ELAPS_T = rtM->Timing.clockTick1 - rtDW.Algorithm_PREV_T;
  }

  rtDW.Algorithm_PREV_T = rtM->Timing.clockTick1;
  rtDW.bitsForTID1.Algorithm_RESET_ELAPS_T = false;
  tmp = 0.001 * (real_T)Algorithm_ELAPS_T;
  for (i = 0; i < 20; i++) {
    if (rtDW.Integrator1_SYSTEM_ENABLE == 0) {
      rtDW.Integrator1_DSTATE[i] += tmp * rtDW.Integrator1_PREV_U[i];
    }

    if (rtDW.Integrator2_SYSTEM_ENABLE == 0) {
      rtDW.Integrator2_DSTATE[i] += tmp * rtDW.Integrator2_PREV_U[i];
    }

    if (rtDW.Integrator3_SYSTEM_ENABLE == 0) {
      rtDW.Integrator3_DSTATE[i] += tmp * rtDW.Integrator3_PREV_U[i];
    }

    rtDW.OutportBufferForOut3[i] = rtDW.Integrator3_DSTATE[i];
    rtDW.Integrator1_PREV_U[i] = rtb_DetAndIntegF2S[i];
    rtDW.Integrator2_PREV_U[i] = rtb_IntegOnlyF2S[i];
    rtDW.Integrator3_PREV_U[i] = rtU.In3[i];
  }

  rtDW.Integrator1_SYSTEM_ENABLE = 0U;
  rtDW.Integrator2_SYSTEM_ENABLE = 0U;
  rtDW.Integrator3_SYSTEM_ENABLE = 0U;
  rtwdemo_rate_DetAndIntegS2F_set(rtDW.Integrator1_DSTATE);
  rtwdemo_ratetr_IntegOnlyS2F_set(rtDW.Integrator2_DSTATE);
  rtM->Timing.clockTick1++;
}

void rtwdemo_ratetrans_initialize(void)
{
  rtDW.bitsForTID1.Algorithm_RESET_ELAPS_T = true;
  rtDW.Integrator1_SYSTEM_ENABLE = 1U;
  rtDW.Integrator2_SYSTEM_ENABLE = 1U;
  rtDW.Integrator3_SYSTEM_ENABLE = 1U;
}
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The rtwdemo_ratetrans_step0 and rtwdemo_ratetrans_step1 functions contain calls to get
and set functions. These functions contain the Rate Transition block code. These function
definitions are in the file rtwdemo_ratetrans_rtb.c.

Generate Inlined Code for Rate Transition blocks

In the Configuration Parameters dialog box, set the Rate Transition block code parameter to
Inline. Generate code for the model. The code is in the files rtwdemo_ratetrans.c and
rtwdemo_ratetrans.h.

set_param('rtwdemo_ratetrans','RateTransitionBlockCode','Inline');
slbuild('rtwdemo_ratetrans')

### Starting build procedure for: rtwdemo_ratetrans
### Successful completion of build procedure for: rtwdemo_ratetrans

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                   
=================================================================================
rtwdemo_ratetrans  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.945s

This code is now in the file rtwdemo_ratetrans.h.

hfile=fullfile(cgDir, 'rtwdemo_ratetrans_ert_rtw','rtwdemo_ratetrans.h');
rtwdemodbtype(hfile, 'typedef struct {', '} DW;', 1, 1);

typedef struct {
  real_T Integrator1_DSTATE[20];
  real_T Integrator2_DSTATE[20];
  real_T Integrator3_DSTATE[20];
  real_T DetAndIntegS2F_Buffer0[20];
  volatile real_T IntegOnlyS2F_Buffer[40];
  real_T DetAndIntegF2S_Buffer[20];
  volatile real_T IntegOnlyF2S_Buffer0[20];
  real_T Integrator1_PREV_U[20];
  real_T Integrator2_PREV_U[20];
  real_T Integrator3_PREV_U[20];
  uint32_T Algorithm_PREV_T;
  struct {
    uint_T Algorithm_RESET_ELAPS_T:1;
  } bitsForTID1;

  volatile int8_T IntegOnlyS2F_ActiveBufIdx;
  volatile int8_T IntegOnlyF2S_semaphoreTaken;
  uint8_T Integrator1_SYSTEM_ENABLE;
  uint8_T Integrator2_SYSTEM_ENABLE;
  uint8_T Integrator3_SYSTEM_ENABLE;
} DW;

For Rate Transition blocks, the state data is not in the global state structure,
DW_rtwdemo_ratetrans_T. This data is in its own structure in the file
rtwdemo_ratetrans_rtb.h.
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This code is now in the file rtwdemo_ratetrans_rtb.c.

cfile=fullfile(cgDir, 'rtwdemo_ratetrans_ert_rtw','rtwdemo_ratetrans.c');
rtwdemodbtype(cfile,'void rtwdemo_ratetrans_step0','void rtwdemo_ratetrans_terminate(void)', 1, 0);

void rtwdemo_ratetrans_step0(void)
{
  int32_T i;
  int32_T i_0;
  (rtM->Timing.RateInteraction.TID0_1)++;
  if ((rtM->Timing.RateInteraction.TID0_1) > 1) {
    rtM->Timing.RateInteraction.TID0_1 = 0;
  }

  if (rtM->Timing.RateInteraction.TID0_1 == 1) {
    memcpy(&rtY.Out1[0], &rtDW.DetAndIntegS2F_Buffer0[0], 20U * sizeof(real_T));
  }

  i = rtDW.IntegOnlyS2F_ActiveBufIdx * 20;
  for (i_0 = 0; i_0 < 20; i_0++) {
    rtY.Out2[i_0] = rtDW.IntegOnlyS2F_Buffer[i_0 + i];
  }

  if (rtM->Timing.RateInteraction.TID0_1 == 1) {
    memcpy(&rtDW.DetAndIntegF2S_Buffer[0], &rtU.In1[0], 20U * sizeof(real_T));
  }

  if (rtDW.IntegOnlyF2S_semaphoreTaken == 0) {
    for (i = 0; i < 20; i++) {
      rtDW.IntegOnlyF2S_Buffer0[i] = rtU.In2[i];
    }
  }
}

void rtwdemo_ratetrans_step1(void)
{
  real_T rtb_IntegOnlyF2S[20];
  real_T tmp;
  int32_T i;
  uint32_T Algorithm_ELAPS_T;
  rtDW.IntegOnlyF2S_semaphoreTaken = 1;
  for (i = 0; i < 20; i++) {
    rtb_IntegOnlyF2S[i] = rtDW.IntegOnlyF2S_Buffer0[i];
  }

  rtDW.IntegOnlyF2S_semaphoreTaken = 0;
  if (rtDW.bitsForTID1.Algorithm_RESET_ELAPS_T) {
    Algorithm_ELAPS_T = 0U;
  } else {
    Algorithm_ELAPS_T = rtM->Timing.clockTick1 - rtDW.Algorithm_PREV_T;
  }

  rtDW.Algorithm_PREV_T = rtM->Timing.clockTick1;
  rtDW.bitsForTID1.Algorithm_RESET_ELAPS_T = false;
  tmp = 0.001 * (real_T)Algorithm_ELAPS_T;
  for (i = 0; i < 20; i++) {
    if (rtDW.Integrator1_SYSTEM_ENABLE == 0) {
      rtDW.Integrator1_DSTATE[i] += tmp * rtDW.Integrator1_PREV_U[i];
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    }

    if (rtDW.Integrator2_SYSTEM_ENABLE == 0) {
      rtDW.Integrator2_DSTATE[i] += tmp * rtDW.Integrator2_PREV_U[i];
    }

    if (rtDW.Integrator3_SYSTEM_ENABLE != 0) {
      rtY.Out3[i] = rtDW.Integrator3_DSTATE[i];
    } else {
      rtY.Out3[i] = tmp * rtDW.Integrator3_PREV_U[i] + rtDW.Integrator3_DSTATE[i];
    }

    rtDW.Integrator1_PREV_U[i] = rtDW.DetAndIntegF2S_Buffer[i];
    rtDW.Integrator2_PREV_U[i] = rtb_IntegOnlyF2S[i];
    rtDW.Integrator3_DSTATE[i] = rtY.Out3[i];
    rtDW.Integrator3_PREV_U[i] = rtU.In3[i];
    rtDW.DetAndIntegS2F_Buffer0[i] = rtDW.Integrator1_DSTATE[i];
  }

  rtDW.Integrator1_SYSTEM_ENABLE = 0U;
  rtDW.Integrator2_SYSTEM_ENABLE = 0U;
  rtDW.Integrator3_SYSTEM_ENABLE = 0U;
  for (i = 0; i < 20; i++) {
    rtDW.IntegOnlyS2F_Buffer[i + (rtDW.IntegOnlyS2F_ActiveBufIdx == 0) * 20] =
      rtDW.Integrator2_DSTATE[i];
  }

  rtDW.IntegOnlyS2F_ActiveBufIdx = (int8_T)(rtDW.IntegOnlyS2F_ActiveBufIdx == 0);
  rtM->Timing.clockTick1++;
}

void rtwdemo_ratetrans_initialize(void)
{
  rtDW.bitsForTID1.Algorithm_RESET_ELAPS_T = true;
  rtDW.Integrator1_SYSTEM_ENABLE = 1U;
  rtDW.Integrator2_SYSTEM_ENABLE = 1U;
  rtDW.Integrator3_SYSTEM_ENABLE = 1U;
}

The code is inlined in functions rtwdemo_ratetrans_step0 and rtwdemo_ratetrans_step1.

Limitation

The code generator does not separate the code and data for Rate Transition blocks that have
variable-size signals or are inside of a For Each Subsystem block.

See Also

• “Rate Transition block code”
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bdclose('rtwdemo_ratetrans');
rtwdemoclean;
cd(currentDir)

See Also

More About
• “Time-Based Scheduling and Code Generation”
• “Sample Times in Subsystems”
• “Sample Times in Systems”
• “Modeling for Multitasking Execution”
• “Configure Time-Based Scheduling”
• “Resolve Rate Transitions”
• “Time-Based Scheduling Example Models”
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Configure Time-Based Scheduling
For details about solver options, see “Solver Pane”.

Configure Start and Stop Times
The value of model configuration parameter Stop time must be greater than or equal to the value of
parameter Start time. If the stop time is zero, or if the total simulation time (Stop minus Start) is
less than zero, the generated program runs for one step. If the stop time is set to inf, the generated
program runs indefinitely.

When using the GRT or ERT targets, you can override the stop time when running a generated
program from the Microsoft Windows command prompt or UNIX4 command line. To override the stop
time that was set during code generation, use the -tf switch.

model -tf n

The program runs for n seconds. If n = inf, the program runs indefinitely.

Certain blocks have a dependency on absolute time. If you are designing a program that is intended
to run indefinitely (model configuration parameter Stop time = inf), and your generated code does
not use the rtModel data structure (that is, it uses simstructs instead), you must not use these
blocks. See “Absolute Time Limitations” on page 27-10 for a list of blocks that can potentially
overflow timers.

If you know how long an application that depends on absolute time needs to run, you can prevent the
timers from overflowing and force the use of optimal word sizes by selecting model configuration
parameter Application lifespan (days). See “Control Memory Allocation for Time Counters” on
page 69-10 for details.

Configure the Solver Type
For code generation, you must configure a model to use a fixed-step solver for system target files
except for S-function and RSim system target files. You can configure the S-function and RSim targets
with a fixed-step or variable-step solver.

Configure the Tasking Mode
The code generator supports both single-tasking and multitasking modes for periodic sample times.
See “Time-Based Scheduling and Code Generation” on page 28-2 for details.

See Also

More About
• “Time-Based Scheduling and Code Generation”
• “Sample Times in Subsystems”
• “Sample Times in Systems”

4. UNIX is a registered trademark of The Open Group in the United States and other countries.
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• “Time-Based Scheduling Example Models”
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Time-Based Scheduling Example Models

Optimize Memory Usage for Time Counters
This example shows how to optimize the amount of memory that the code generator allocates for time
counters. The example optimizes the memory that stores elapsed time, the interval of time between
two events.

The code generator represents time counters as unsigned integers. The word size of time counters is
based on the setting of the model configuration parameter Application lifespan (days), which
specifies the expected maximum duration of time the application runs. You can use this parameter to
prevent time counter overflows. The default size is 64 bits.

The number of bits that a time counter uses depends on the setting of the Application lifespan
(days) parameter. For example, if a time counter increments at a rate of 1 kHz, to avoid an overflow,
the counter has the following number of bits:

• Lifespan < 0.25 sec: 8 bits
• Lifespan < 1 min: 16 bits
• Lifespan < 49 days: 32 bits
• Lifespan > 50 days: 64 bits

A 64-bit time counter does not overflow for 590 million years.

Open Example Model

Open the example model rtwdemo_abstime.
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The model consists of three subsystems SS1, SS2, and SS3. On the Math and Data Types pane, the
Application lifespan (days) parameter is set to the default, which is inf.

The three subsystems contain a discrete-time integrator that requires elapsed time as input to
compute its output value. The subsystems vary as follows:

• SS1 - Clocked at 1 kHz. Does not require a time counter. Sample time type parameter for trigger
port is set to periodic. Elapsed time is inlined as 0.001.

• SS2 - Clocked at 100 Hz. Requires a time counter. Based on a lifespan of 1 day, a 32-bit counter
stores the elapsed time.

• SS3 - Clocked at 0.5 Hz. Requires a time counter. Based on a lifespan of 1 day, a 16-bit counter
stores the elapsed time.

Simulate the Model

Simulate the model. By default, the model is configured to show sample times in different colors.
Discrete sample times for the three subsystems appear red, green, and blue. Triggered subsystems
are blue-green.

Generate Code and Report

1. Create a temporary folder for the build and inspection process.

2. Configure the model for the code generator to use the GRT system target file and a lifespan of inf
days.

3. Build the model.
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### Starting build procedure for: rtwdemo_abstime
### Successful completion of build procedure for: rtwdemo_abstime

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                                    
================================================================================================
rtwdemo_abstime  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.681s

Review Generated Code

Open the generated source file rtwdemo_abstime.c.

struct tag_RTM_rtwdemo_abstime_T {
  const char_T *errorStatus;

  /*
   * Timing:
   * The following substructure contains information regarding
   * the timing information for the model.
   */
  struct {
    uint32_T clockTick1;
    uint32_T clockTickH1;
    uint32_T clockTick2;
    uint32_T clockTickH2;
    struct {
      uint16_T TID[3];
      uint16_T cLimit[3];
    } TaskCounters;
  } Timing;
};

/* Block states (default storage) */
extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

/* Zero-crossing (trigger) state */
extern PrevZCX_rtwdemo_abstime_T rtwdemo_abstime_PrevZCX;

/* External inputs (root inport signals with default storage) */
extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

/* External outputs (root outports fed by signals with default storage) */
extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;

/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step0(void);
extern void rtwdemo_abstime_step1(void);
extern void rtwdemo_abstime_step2(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);
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/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*-
 * The generated code includes comments that allow you to trace directly
 * back to the appropriate location in the model.  The basic format
 * is <system>/block_name, where system is the system number (uniquely
 * assigned by Simulink) and block_name is the name of the block.
 *
 * Use the MATLAB hilite_system command to trace the generated code back
 * to the model.  For example,
 *
 * hilite_system('<S3>')    - opens system 3
 * hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3
 *
 * Here is the system hierarchy for this model
 *
 * '<Root>' : 'rtwdemo_abstime'
 * '<S1>'   : 'rtwdemo_abstime/SS1'
 * '<S2>'   : 'rtwdemo_abstime/SS2'
 * '<S3>'   : 'rtwdemo_abstime/SS3'
 */
#endif                                 /* RTW_HEADER_rtwdemo_abstime_h_ */

Four 32-bit unsigned integers, clockTick1 , clockTickH1 , clockTick2 , and clockTickH2 are
counters for storing the elapsed time of subsystems SS2 and SS3.

Enable Optimization and Regenerate Code

1. Reconfigure the model to set the lifespan to 1 day.

2. Build the model.

### Starting build procedure for: rtwdemo_abstime
### Successful completion of build procedure for: rtwdemo_abstime

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                     
=================================================================================
rtwdemo_abstime  Code generated and compiled  Incremental checksum has changed.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.185s

Review the Regenerated Code

struct tag_RTM_rtwdemo_abstime_T {
  const char_T *errorStatus;

  /*
   * Timing:
   * The following substructure contains information regarding
   * the timing information for the model.
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   */
  struct {
    uint32_T clockTick1;
    uint16_T clockTick2;
    struct {
      uint16_T TID[3];
      uint16_T cLimit[3];
    } TaskCounters;
  } Timing;
};

/* Block states (default storage) */
extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

/* Zero-crossing (trigger) state */
extern PrevZCX_rtwdemo_abstime_T rtwdemo_abstime_PrevZCX;

/* External inputs (root inport signals with default storage) */
extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

/* External outputs (root outports fed by signals with default storage) */
extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;

/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step0(void);
extern void rtwdemo_abstime_step1(void);
extern void rtwdemo_abstime_step2(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*-
 * The generated code includes comments that allow you to trace directly
 * back to the appropriate location in the model.  The basic format
 * is <system>/block_name, where system is the system number (uniquely
 * assigned by Simulink) and block_name is the name of the block.
 *
 * Use the MATLAB hilite_system command to trace the generated code back
 * to the model.  For example,
 *
 * hilite_system('<S3>')    - opens system 3
 * hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3
 *
 * Here is the system hierarchy for this model
 *
 * '<Root>' : 'rtwdemo_abstime'
 * '<S1>'   : 'rtwdemo_abstime/SS1'
 * '<S2>'   : 'rtwdemo_abstime/SS2'
 * '<S3>'   : 'rtwdemo_abstime/SS3'
 */
#endif                                 /* RTW_HEADER_rtwdemo_abstime_h_ */

The new setting for the Application lifespan (days) parameter instructs the code generator to set
aside less memory for the time counters. The regenerated code includes:
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• 32-bit unsigned integer, clockTick1, for storing the elapsed time of the task for SS2
• 16-bit unsigned integer, clockTick2, for storing the elapsed time of the task for SS3

Related Information

• “Model Configuration Parameters: Code Generation Optimization”
• “Timers in Asynchronous Tasks”
• “Time-Based Scheduling and Code Generation”

Single-Rate Modeling (Bare Board, No OS)
This model shows code generation for a single-rate discrete-time model configured for a bare-board
target (one with no operating system).

Open Example Model

Open the example model rtwdemo_srbb.

open_system('rtwdemo_srbb')

The model uses one sample time and is configured to display sample-time colors when an update
diagram occurs. Inport blocks In1_1s and In2_1s specify a 1-second sample time, which is enforced by
the setting of model configuration parameter Periodic sample time constraint.

The model is configured to display color-coded sample times with annotations. To see them, after
opening the model, update the diagram by pressing Ctrl+D. To display the legend, press Ctrl+J.
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Because the model is configured with one sample time, the model appears red, which is the color that
represents the fastest discrete sample time in the model.

Multirate Modeling in Single-Tasking Mode (Bare Board, no OS)
This model shows the code generated for a multirate discrete-time model configured for single-
tasking on a bare-board target (one with no operating system).

Open Example Model

Open the example model rtwdemo_mrstbb.

open_system('rtwdemo_mrstbb')

The model contains two sample times. Inport block 1 and Inport block 2 specify 1-second and 2-
second sample times, respectively, which are enforced by the setting of model configuration
parameter Periodic sample time constraint. The solver is set for single-tasking operation. Rate
transition blocks are, therefore, not included between blocks executing at different sample times
because preemption will not occur.

The model is configured to display color-coded sample times with annotations. To see them, after
opening the model, update the diagram by pressing Ctrl+D. To display the legend, press Ctrl+J. Red
represents the fastest discrete sample time in the model, green represents the second fastest, and
yellow represents mixed sample times.

Multirate Modeling in Multitasking Mode (Bare Board, no OS)
This model shows the code generated for a multirate discrete-time model configured for a
multitasking bare-board target (one with no operating system).

Open Example Model

Open the example model rtwdemo_mrmtbb.
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open_system('rtwdemo_mrmtbb')

Explore Example Model

The model contains two sample times. Inport block 1 and Inport block 2 specify 1-second and 2-
second sample times, respectively, which are enforced by the setting of model configuration
parameter Periodic sample time constraint. The solver is set for multitasking operation, which
means a rate transition block is required to ensure that data integrity is enforced when the 1-second
task preempts the 2-second task. Proper rate transitions are always enforced by Simulink and
Simulink Coder. This model specifies an explicit rate transition block. Alternatively, this block could
be automatically inserted by Simulink setting model configuration parameter Automatically handle
rate transition for data transfer.

The model is configured to display sample-time colors upon diagram update. To see them, after
opening the model, update the diagram by pressing Ctrl+D. To display the legend, press Ctrl+J. Red
represents the fastest discrete sample time in the model, green represents the second fastest, and
yellow represents mixed sample times.

Data Transfer Assumptions

Basis of operation for data transfers between tasks:

• Data transitions occur between a single reading task and a single writing task.
• A read or write of a byte sized variable is atomic.
• When two tasks interact through a data transition, only one of them can preempt the other.
• For periodic tasks, the faster rate task has higher priority than the slower rate task; the faster rate

task always preempts the slower rate task.
• Tasks run on a single processor. Time slicing is not allowed.
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• Processes do not crash and restart (especially while data is being transferred between tasks)

Multirate Modeling in Multitasking Mode (VxWorks® OS)
This example generates code for a multirate discrete-time model configured for a multitasking
operating system target (VxWorks®). The model contains two sample times. Inport block 1 and Inport
block 2 specify 1-second and 2-second sample times, respectively, which are enforced by the setting
of model configuration parameter Periodic sample time constraint. The solver is set for
multitasking operation, which means a Rate Transition block is required to ensure that data integrity
is enforced when the 1-second task preempts the 2-second task. Simulink® and the code generator
enforce proper rate transitions. This model specifies an explicit Rate Transition block. Alternatively,
you can instruct Simulink® to insert this block for you by setting model configuration parameter
Automatically handle rate transition for data transfer.

The model is configured to display color-coded sample times with annotations. To see them, after
opening the model, update the diagram by pressing Ctrl+D. To display the legend, press Ctrl+J. Red
represents the fastest discrete sample time in the model, green represents the second fastest, and
yellow represents mixed sample times.

Example Model
model = 'rtwdemo_mrmtos';
open_system(model);

Trade Determinism and Data Integrity to Improve System Performance
This model shows the differences in the operation modes of the Rate Transition block when used in a
multirate, multitasking model. The flexible options for the Rate Transition block allow you to select
the mode that is best suited for your application. You can trade levels of determinism and data
integrity to improve system performance.

Rate Transition Block Modes of Operation

Ensure data integrity and determinism (DetAndInteg) : Data is transferred such that all data
bytes for the signal (including all elements of a wide signal) are from the same time step. Additionally,
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it is ensured that the relative sample time (delay) from which the data is transferred from one rate to
another is always the same. Only ANSI-C code is used, no target specific 'critical section' protection is
needed.

Ensure integrity (IntegOnly) : Data is transferred such that all data bytes for the signal (including
all elements of a wide signal) are from the same time step. However, from one transfer of data to the
next, the relative sample time (delay) for which the data is transferred can vary. In this mode, the
code to read/write the data is run more often than in the DetandInt mode. In the worst case, the delay
is equivalent to the DetandInt mode, but the delay can be less which is important is some
applications. Also, this mode support data transfers to/from asynchronous rates which the DetandInt
mode cannot support. Only ANSI-C code is used, no target specific 'critical section' protection is
needed.

No data consistency operations are performed (None) : For this case, the Rate Transition block
does not generated code. This mode is acceptable in some application where atomic access of scalar
data types is guaranteed and when the relative temporal values of the data is not important. This
mode does not introduce any delay.

Data Transfer Assumptions

Basis of operation for data transfers between tasks:

• Data transitions occur between a single reading task and a single writing task.
• A read or write of a byte sized variable is atomic.
• When two tasks interact through a data transition, only one of them can preempt the other.
• For periodic tasks, the faster rate task has higher priority than the slower rate task; the faster rate

task always preempts the slower rate task.
• All tasks run on a single processor. Time slicing is not allowed.
• Processes do not crash/restart (especially while data is being transferred between tasks)

Model rtwdemo_ratetrans

open_system('rtwdemo_ratetrans')
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Model rtwdemo_ratetrans shows the differences in the operation modes of the following Rate
Transition blocks.

Rate Transition block DetAndIntegF2S

Determinism and data integrity (fast to slow transition):

• The block output is used as a persistent data buffer.
• Data is written to output at slower rate but done during the faster rate context
• Data as seen by the slower rate is always the value when both the faster and slower rate last

executed. Any subsequent steps by the faster rate (and associated data updates) while the slower
rate is running are not seen by the slower rate.

Rate Transition block DetAndIntegS2F

Determinism and data integrity (slow to fast transition):

• Uses two persistent data buffers, an internal buffer and the blocks output.
• The internal buffer is copied to the output at the slower rate but done during the faster rate

context.
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• The internal buffer is written at the slower rate and during the slower rate context.
• The data that Fast rate sees is always delayed, i.e. data is from the previous step of the slow rate

code.

Rate Transition block IntegOnlyF2S

Data integrity only (fast to slow transition):

• The block output is used as a persistent data buffer.
• Data is written to buffer during the faster rate context if a flag indicates it not in the process of

being read.
• The flag is set and data is copied from the buffer to output at the slow rate, the flag is then

cleared. This is an additional copy as compared to the deterministic case.
• Data as seen by the slower rate can be from a more recent step of the faster rate than from when

the slower rate and faster rate both executed.

Rate Transition block IntegOnlyS2F

Data integrity only (slow to fast transition):

• Uses two persistent data buffers, both are internal buffers.
• One of the 2 buffers is always copied to the output at faster rate.
• One of the 2 buffers is written at the slower rate and during the slower rate context, then the

active buffer is switched.
• The data as seen by the faster rate can be more recent than for the deterministic case.
Specifically, when both the slower and faster rate have their hits, the faster rate will see a
previous value from the slower rate. But, subsequent steps for the faster rate may see an updated
value (when the slower rate updates the non-active buffer and switches the active buffer flag.

Rate Transition block NoneF2S

No code is generated for the Rate Transition block when determinism and data integrity is waived.

Rate Transition block NoneS2F

No code is generated for the Rate Transition block when determinism and data integrity is waived.

bdclose('rtwdemo_ratetrans');

See Also

More About
• “Time-Based Scheduling and Code Generation”
• “Modeling for Single-Tasking Execution”
• “Modeling for Multitasking Execution”
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Event-Based Scheduling in Simulink
Coder

• “Asynchronous Events” on page 29-2
• “Generate Interrupt Service Routines” on page 29-5
• “Spawn and Synchronize Execution of RTOS Task” on page 29-11
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 29-28
• “Rate Transitions and Asynchronous Blocks” on page 29-35
• “Timers in Asynchronous Tasks” on page 29-39
• “Create a Customized Asynchronous Library” on page 29-41
• “Import Asynchronous Event Data for Simulation” on page 29-48
• “Asynchronous Support Limitations” on page 29-51
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Asynchronous Events

Asynchronous Support
Normally, you time models from which you plan to generate code from a periodic interrupt source (for
example, a hardware timer). Blocks in a periodically clocked single-rate model run at a timer
interrupt rate (the base rate of the model). Blocks in a periodically clocked multirate model run at the
base rate or at multiples of that rate.

Many systems must also support execution of blocks in response to events that are asynchronous with
respect to the periodic timing source of the system. For example, a peripheral device might signal
completion of an input operation by generating an interrupt. The system must service such
interrupts, for example, by acquiring data from the interrupting device.

This topic explains how to use blocks to model and generate code for asynchronous event handling,
including servicing of hardware-generated interrupts, maintenance of timers, asynchronous read and
write operations, and spawning of asynchronous tasks under a real-time operating system (RTOS).
This block library demonstrates integration with an example RTOS (VxWorks). Although the blocks
target an example RTOS, this chapter provides source code analysis and other information you can
use to develop blocks that support asynchronous event handling for an alternative target RTOS.5

Block Library for Calls to an Example Real-Time Operating System
The next figure shows the blocks in the vxlib1 block library.

The key blocks in the library are the Async Interrupt and Task Sync blocks. These blocks are targeted
for an example RTOS (VxWorks). You can use them, with modification, to support your RTOS
applications.

Note You can use the blocks in the vxlib1 library (Async Interrupt and Task Sync) for simulation
and code generation. These blocks provide starting point examples to help you develop custom blocks
for your target environment.

To implement asynchronous support for an RTOS other than the example RTOS, use the guidelines
and example code are provided to help you adapt the vxlib1 library blocks to target your RTOS. This
topic is discussed in “Create a Customized Asynchronous Library” on page 29-41.

5. VxWorks is a registered trademark of Wind River Systems, Inc.
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The vxlib1 library includes blocks you can use to

• Generate interrupt-level code — Async Interrupt block
• Spawn an RTOS task that calls a function call subsystem — Task Sync block
• Enable data integrity when transferring data between blocks running as different tasks —

Protected RT block
• Use an unprotected/nondeterministic mode when transferring data between blocks running as
different tasks — Unprotected RT block

The use of protected and unprotected Rate Transition blocks in asynchronous contexts is discussed in
“Rate Transitions and Asynchronous Blocks” on page 29-35. For general information on rate
transitions, see “Time-Based Scheduling and Code Generation” on page 28-2.

Access the Block Library for RTOS Integration
To access the example RTOS (VxWorks) block library, enter the MATLAB command vxlib1.

Generate Code Using Library Blocks for RTOS Integration
To generate an example RTOS compatible application from a model containing vxlib1 library blocks,
use the following model configuration parameter settings for your model.

• Set System target file (SystemTargetFile) to ert.tlc (requires an Embedded Coder license).
• Select Generate code only (GenCodeOnly).
• Select Generate an example main program (GenerateSampleERTMain).
• Set Target operating system (TargetOS) to VxWorksExample.

Examples and Additional Information
Additional information relevant to the topics in this chapter can be found in

• The rtwdemo_async model, which uses the tornado.tlc system target file and vxlib1 block
library. To open this example, type rtwdemo_async at the MATLAB command prompt.

• The rtwdemo_async_mdlreftop model, which uses the tornado.tlc system target file and
vxlib1 block library. To open this example, type rtwdemo_async_mdlreftop at the MATLAB
command prompt.

• “Time-Based Scheduling and Code Generation”, discusses general multitasking and rate transition
issues for periodic models.

• The Embedded Coder documentation discusses the ert.tlc system target file, including task
execution and scheduling.

• For detailed information about the system calls to the example RTOS (VxWorks) mentioned in this
chapter, see VxWorks system documentation on the Wind River website.
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See Also

More About
• “Time-Based Scheduling and Code Generation”
• “Generate Interrupt Service Routines”
• “Spawn and Synchronize Execution of RTOS Task”
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model”
• “Timers in Asynchronous Tasks”
• “Import Asynchronous Event Data for Simulation”
• “Rate Transitions and Asynchronous Blocks”
• “Create a Customized Asynchronous Library”
• “Asynchronous Support Limitations”
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Generate Interrupt Service Routines
To generate an interrupt service routine (ISR) associated with a specific VME interrupt level for the
example RTOS (VxWorks), use the Async Interrupt block. The Async Interrupt block enables the
specified interrupt level and installs an ISR that calls a connected function call subsystem.

You can also use the Async Interrupt block in a simulation. It provides an input port that can be
enabled and connected to a simulated interrupt source.

Note The operating system integration techniques that are demonstrated in this section use one or
more blocks the blocks in the vxlib1 library. These blocks provide starting point examples to help
you develop custom blocks for your target environment.

Connecting the Async Interrupt Block
To generate an ISR, connect an output of the Async Interrupt block to the control input of

• A function call subsystem
• The input of a Task Sync block
• The input to a Stateflow chart configured for a function call input event

The next figure shows an Async Interrupt block configured to service two interrupt sources. The
outputs (signal width 2) are connected to two function call subsystems.

Requirements and Restrictions
Note the following requirements and restrictions:

• The Async Interrupt block supports VME interrupts 1 through 7.
• The Async Interrupt block uses the following system calls to the example RTOS (VxWorks):

• sysIntEnable
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• sysIntDisable
• intConnect
• intLock
• intUnlock
• tickGet

Performance Considerations
Execution of large subsystems at interrupt level can have a significant impact on interrupt response
time for interrupts of equal and lower priority in the system. As a general rule, it is best to keep ISRs
as short as possible. Connect only function call subsystems that contain a small number of blocks to
an Async Interrupt block.

A better solution for large subsystems is to use the Task Sync block to synchronize the execution of
the function call subsystem to a RTOS task. The Task Sync block is placed between the Async
Interrupt block and the function call subsystem. The Async Interrupt block then installs the Task Sync
block as the ISR. The ISR releases a synchronization semaphore (performs a semGive) to the task,
and returns immediately from interrupt level. The task is then scheduled and run by the example
RTOS (VxWorks). See “Spawn and Synchronize Execution of RTOS Task” on page 29-11 for more
information.

Using the Async Interrupt Block in Simulation and Code Generation
This section describes a dual-model approach to the development and implementation of real-time
systems that include ISRs. In this approach, you develop one model that includes a plant and a
controller for simulation, and another model that only includes the controller for code generation.
Using a Simulink library, you can implement changes to both models simultaneously. The next figure
shows how changes made to the plant or controller, both of which are in a library, are propagated to
the models.

Dual-Model Use of Async Interrupt Block for Simulation and Code Generation

A single-model approach is also possible. In this approach, the Plant component of the model is active
only in simulation. During code generation, the Plant components are effectively switched out of the
system and code is generated only for the interrupt block and controller parts of the model. For an
example of this approach, see the rtwdemo_async model.
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Dual-Model Approach: Simulation
The following block diagram shows a simple model that illustrates the dual-model approach to
modeling. During simulation, the Pulse Generator blocks provide simulated interrupt signals.

The simulated interrupt signals are routed through the Async Interrupt block's input port. Upon
receiving a simulated interrupt, the block calls the connected subsystem.

During simulation, subsystems connected to Async Interrupt block outputs are executed in order of
their priority in the example RTOS (VxWorks). In the event that two or more interrupt signals occur
simultaneously, the Async Interrupt block executes the downstream systems in the order specified by
their interrupt levels (level 7 gets the highest priority). The first input element maps to the first
output element.

You can also use the Async Interrupt block in a simulation without enabling the simulation input. In
such a case, the Async Interrupt block inherits the base rate of the model and calls the connected
subsystems in order of their priorities in the RTOS. (In this case, the Async Interrupt block behaves
as if all inputs received a 1 simultaneously.)

Dual-Model Approach: Code Generation
In the generated code for the sample model,

• Ground blocks provide input signals to the Environment Controller block
• The Async Interrupt block does not use its simulation input

The Ground blocks drive control input of the Environment Controller block, so code is not generated
for that signal path. The code generator does not produce code for blocks that drive the simulation
control input to the Environment Controller block because that path is not selected during code
generation. However, the sample times of driving blocks for the simulation input to the Environment
Controller block contribute to the sample times supported in the generated code. To avoid including
unnecessary sample times in the generated code, use the sample times of the blocks driving the
simulation input in the model where generated code is intended.
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Standalone functions are installed as ISRs and the interrupt vector table is as follows:

Offset  
192 &isr_num1_vec192()
193 &isr_num2_vec193()

Consider the code generated from this model, assuming that the Async Interrupt block parameters
are configured as shown in the next figure.
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Initialization Code

In the generated code, the Async Interrupt block installs the code in the Subsystem blocks as
interrupt service routines. The interrupt vectors for IRQ1 and IRQ2 are stored at locations 192 and
193 relative to the base of the interrupt vector table, as specified by the VME interrupt vector
offset(s) parameter.

Installing an ISR requires two RTOS (VxWorks) calls, int_connect and sysInt_Enable. The Async
Interrupt block inserts these calls in the model_initialize function, as shown in the following
code excerpt.
/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Connect and enable ISR function: isr_num1_vec192 */
    if( intConnect(INUM_TO_IVEC(192), isr_num1_vec192, 0) != OK) {
      printf("intConnect failed for ISR 1.\n");
    }
    sysIntEnable(1);

    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Connect and enable ISR function: isr_num2_vec193 */
    if( intConnect(INUM_TO_IVEC(193), isr_num2_vec193, 0) != OK)
    {
      printf("intConnect failed for ISR 2.\n");
    }
    sysIntEnable(2);

The hardware that generates the interrupt is not configured by the Async Interrupt block. Typically,
the interrupt source is a VME I/O board, which generates interrupts for specific events (for example,
end of A/D conversion). The VME interrupt level and vector are set up in registers or by using
jumpers on the board. You can use the mdlStart routine of a user-written device driver (S-function)
to set up the registers and enable interrupt generation on the board. You must match the interrupt
level and vector specified in the Async Interrupt block dialog to the level and vector set up on the I/O
board.

Generated ISR Code

The actual ISR generated for IRQ1 in the RTOS (VxWorks) is listed below.

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */

void isr_num1_vec192(void)
{
  int_T lock;
  FP_CONTEXT context;

   /* Use tickGet() as a portable tick counter example. 
      A much higher resolution can be achieved with a 
      hardware counter */
   Async_Code_M->Timing.clockTick2 = tickGet();

   /* disable interrupts (system is configured as non-ive) */
   lock = intLock();

   /* save floating point context */
   fppSave(&context);
 
   /* Call the system: <Root>/Subsystem A */
   Count(0, 0);

   /* restore floating point context */
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   fppRestore(&context);

   /* re-enable interrupts */
   intUnlock(lock);
}

There are several features of the ISR that should be noted:

• Because of the setting of the Preemption Flag(s) parameter, this ISR is locked; that is, it cannot
be preempted by a higher priority interrupt. The ISR is locked and unlocked in the example RTOS
(VxWorks) by the int_lock and int_unlock functions.

• The connected subsystem, Count, is called from within the ISR.
• The Count function executes algorithmic (model) code. Therefore, the floating-point context is

saved and restored across the call to Count.
• The ISR maintains its own absolute time counter, which is distinct from other periodic base rate or

subrate counters in the system. Timing data is maintained for the use of any blocks executed
within the ISR that require absolute or elapsed time.

See “Timers in Asynchronous Tasks” on page 29-39 for details.

Model Termination Code

The model's termination function disables the interrupts in the RTOS (VxWorks):

/* Model terminate function */
void Async_Code_terminate(void)
{
   /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
   /* Disable interrupt for ISR system: isr_num1_vec192 */
   sysIntDisable(1);

   /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
   /* Disable interrupt for ISR system: isr_num2_vec193 */
   sysIntDisable(2);
}

See Also

More About
• “Spawn and Synchronize Execution of RTOS Task”
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model”
• “Import Asynchronous Event Data for Simulation”
• “Rate Transitions and Asynchronous Blocks”

29 Event-Based Scheduling in Simulink Coder

29-10



Spawn and Synchronize Execution of RTOS Task
This example shows how to simulate and generate code for asynchronous events on a real-time
multitasking system. The model contains an Async Interrupt block, a Task Sync block, asynchronously
executed subsystems Count and Algorithm, and Rate Transition blocks. The Async Interrupt block
creates two Versa Module Eurocard (VME) interrupt service routines (ISRs) that pass interrupt
signals to subsystem Count and the Task Sync block.|Count| executes at interrupt level. Algorithm
executes as an asynchronous task. The code that the code generator produces for subsystems is
tailored for the VxWorks® operating system.

About the Example Model

Open the example model rtwdemo_async.

You can place an Async Interrupt block between a simulated interrupt source and one of these model
elements:

• Function call subsystem
• Task Sync block
• A Stateflow® chart configured for a function call input event
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• A referenced model with an Inport block that connects to one of the preceding model elements

The Async Interrupt and Task Sync blocks enable the subsystems to execute asynchronously.
Reconfigure the Async Interrupt and Task Sync blocks to generate code for an alternative run-time
environment.

Count represents a simple interrupt service routine (ISR) that executes at interrupt level. It is best to
keep ISRs as simple as possible. This subsystem includes only a Discrete-Time Integrator block.

Algorithm includes more substance. It includes multiple blocks and produces two output values.
Execution of larger subsystems at interrupt level can significantly impact response time for interrupts
of equal and lower priority in the system. A better solution for larger subsystems is to use the Task
Sync block to represent the ISR for the function-call subsystem.

The Async Interrupt block generates calls to ISRs. Place the block between a simulated interrupt
source and one of the following:

• Function call subsystem
• Task Sync block
• A Stateflow® chart configured for a function call input event

For each specified interrupt level, the block generates a Versa Module Eurocard (VME) ISR that
executes the connected subsystem, Task Sync block, or chart.

In the example model, the Async Interrupt block is configured for VME interrupts 1 and 2, by using
interrupt vector offsets 192 and 193. Interrupt 1 connects directly to subsystem Count. Interrupt 2
connects to a Task Sync block, which serves as the ISR for Algorithm. Place a Task Sync block in
one of the following locations:

• Between an Async Interrupt block and a function-call subsystem or Stateflow® chart.
• At the output port of a Stateflow® chart that has an event, Output to Simulink, that you
configure as a function call.

In the example model, the Task Sync block is between the Async Interrupt block and function-call
subsystem Algorithm. The Task Sync block is configured with the task name Task(), a priority of
50, a stack size of 8192, and data transfers of the task synchronized with the caller task. The
spawned task uses a semaphore to synchronize task execution. The Async Interrupt block triggers a
release of the task semaphore.

Four Rate Transition blocks handle data transfers between ports that operate at different rates. In
two instances, Protected Rate Transition blocks protect data transfers (prevent them from being
preempted and corrupted). In the other two instances, Unprotected Rate Transition blocks introduce
no special behavior. Their presence informs Simulink® of a rate transition.

The code generated for the Async Interrupt and Task Sync blocks is tailored for the example RTOS
(VxWorks®). However, you can modify the blocks to generate code specific to your run-time
environment.

Data Transfer Assumptions

• Data transfers occur between one reading task and one writing task.
• A read or write operation on a byte-size variable is atomic.
• When two tasks interact, only one can preempt the other.
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• For periodic tasks, the task with the faster rate has higher priority than the task with the slower
rate. The task with the faster rate preempts the tasks with slower rates.

• Tasks run on a single processor. Time slicing is not allowed.
• Processes do not stop and restart, especially while data is being transferred between tasks.

Simulate the Model

Simulate the model. By default, the model is configured to show sample times in different colors.
Discrete sample times for input and output appear red and green, respectively. Constants are reddish-
blue. Asynchronous interrupts and tasks are purple. The Rate Transition Blocks, which are a hybrid
rate (their input and output sample times can differ), are yellow.

Generate Code and Report

Generate code and a code generation report for the model. Generated code for the Async Interrupt
and Task Sync blocks is for the example RTOS (VxWorks®). However, you can modify the blocks to
generate code for another run-time environment.

1. Create a temporary folder for the build and inspection process.

2. Build the model.

### Starting build procedure for: rtwdemo_async
Warning: Simulink Coder: The tornado.tlc target will be removed in a future
release.
 
### Successful completion of code generation for: rtwdemo_async

Build Summary

Top model targets built:

Model          Action          Rebuild Reason                                    
=================================================================================
rtwdemo_async  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.752s

Review Initialization Code

Open the generated source file rtwdemo_async.c. The initialization code:

1. Creates and initializes the synchronization semaphore Task0_semaphore.

  *(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID = semBCreate(SEM_Q_PRIORITY,
    SEM_EMPTY);
  if (rtwdemo_async_DW.SFunction_PWORK.SemID == NULL) {
    printf("semBCreate call failed for block Task0.\n");
  }

2. Spawns task task0 and assigns the task priority 50.

  rtwdemo_async_DW.SFunction_IWORK.TaskID = taskSpawn("Task0",
    50.0,
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    VX_FP_TASK,
    8192.0,
    (FUNCPTR)Task0,
    0, 0, 0, 0, 0, 0, 0,0, 0, 0);
  if (rtwdemo_async_DW.SFunction_IWORK.TaskID == ERROR) {
    printf("taskSpawn call failed for block Task0.\n");
  }

  /* End of Start for S-Function (vxtask1): '<S5>/S-Function' */

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Connect and enable ISR function: isr_num1_vec192 */
  if (intConnect(INUM_TO_IVEC(192), isr_num1_vec192, 0) != OK) {
    printf("intConnect failed for ISR 1.\n");
  }

  sysIntEnable(1);

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Connect and enable ISR function: isr_num2_vec193 */
  if (intConnect(INUM_TO_IVEC(193), isr_num2_vec193, 0) != OK) {
    printf("intConnect failed for ISR 2.\n");
  }

  sysIntEnable(2);

3. Connects and enables ISR isr_num1_vec192 for interrupt 1 and ISR isr_num2_vec193 for
interrupt 2.

  {
    int32_T i;

    /* InitializeConditions for RateTransition: '<Root>/Protected RT1' */
    for (i = 0; i < 60; i++) {
      rtwdemo_async_DW.ProtectedRT1_Buffer[i] = 0.0;
    }

    /* End of InitializeConditions for RateTransition: '<Root>/Protected RT1' */

    /* InitializeConditions for RateTransition: '<Root>/Protected RT2' */
    for (i = 0; i < 60; i++) {
      rtwdemo_async_DW.ProtectedRT2_Buffer[i] = 0.0;
    }

    /* End of InitializeConditions for RateTransition: '<Root>/Protected RT2' */

    /* SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
     *  SubSystem: '<Root>/Count'
     */
    /* System initialize for function-call system: '<Root>/Count' */

    /* InitializeConditions for DiscreteIntegrator: '<S2>/Integrator' */
    rtwdemo_async_DW.Integrator_DSTATE_l = 0.0;
    rtwdemo_async_DW.Integrator_PREV_U_o = 0.0;

    /* SystemInitialize for Outport: '<Root>/Out1' incorporates:
     *  Outport: '<S2>/Out'
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     */
    rtwdemo_async_Y.Out1 = 0.0;

    /* SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
     *  SubSystem: '<S4>/Subsystem'
     */
    /* System initialize for function-call system: '<S4>/Subsystem' */

    /* SystemInitialize for S-Function (vxtask1): '<S5>/S-Function' incorporates:
     *  SubSystem: '<Root>/Algorithm'
     */

    /* System initialize for function-call system: '<Root>/Algorithm' */
    rtwdemo_async_M->Timing.clockTick2 = rtwdemo_async_M->Timing.clockTick4;

    /* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
    rtwdemo_async_DW.Integrator_DSTATE = 0.0;

    /* InitializeConditions for Sum: '<S1>/Sum1' incorporates:
     *  DiscreteIntegrator: '<S1>/Integrator'
     */
    rtwdemo_async_DW.Integrator_PREV_U = 0.0;

    /* SystemInitialize for Sum: '<S1>/Sum' incorporates:
     *  Outport: '<S1>/Out1'
     */
    memset(&rtwdemo_async_B.Sum[0], 0, 60U * sizeof(real_T));

    /* SystemInitialize for Outport: '<Root>/Out3' incorporates:
     *  Outport: '<S1>/Out2'
     */
    rtwdemo_async_Y.Out3 = 0.0;

    /* End of SystemInitialize for S-Function (vxtask1): '<S5>/S-Function' */

    /* End of SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }

  /* Enable for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
   *  SubSystem: '<Root>/Count'
   */
  /* Enable for function-call system: '<Root>/Count' */
  rtwdemo_async_DW.Count_RESET_ELAPS_T = true;

  /* Enable for DiscreteIntegrator: '<S2>/Integrator' */
  rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h = 1U;

  /* Enable for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
   *  SubSystem: '<S4>/Subsystem'
   */

  /* Enable for function-call system: '<S4>/Subsystem' */

  /* Enable for S-Function (vxtask1): '<S5>/S-Function' incorporates:
   *  SubSystem: '<Root>/Algorithm'
   */

  /* Enable for function-call system: '<Root>/Algorithm' */
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  rtwdemo_async_M->Timing.clockTick2 = rtwdemo_async_M->Timing.clockTick4;
  rtwdemo_async_DW.Algorithm_RESET_ELAPS_T = true;

  /* Enable for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_async_DW.Integrator_SYSTEM_ENABLE = 1U;

  /* End of Enable for S-Function (vxtask1): '<S5>/S-Function' */

  /* End of Enable for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
}

/* Model terminate function */
static void rtwdemo_async_terminate(void)
{
  /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Disable interrupt for ISR system: isr_num1_vec192 */
  sysIntDisable(1);

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Disable interrupt for ISR system: isr_num2_vec193 */
  sysIntDisable(2);

  /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

  /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
   *  SubSystem: '<S4>/Subsystem'
   */

  /* Termination for function-call system: '<S4>/Subsystem' */

  /* Terminate for S-Function (vxtask1): '<S5>/S-Function' */

  /* VxWorks Task Block: '<S5>/S-Function' (vxtask1) */
  /* Destroy task: Task0 */
  taskDelete(rtwdemo_async_DW.SFunction_IWORK.TaskID);

  /* End of Terminate for S-Function (vxtask1): '<S5>/S-Function' */

  /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
}

/*========================================================================*
 * Start of Classic call interface                                        *
 *========================================================================*/
void MdlOutputs(int_T tid)
{
  rtwdemo_async_output(tid);
}

void MdlUpdate(int_T tid)
{
  rtwdemo_async_update(tid);
}

void MdlInitializeSizes(void)
{
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}

void MdlInitializeSampleTimes(void)
{
}

void MdlInitialize(void)
{
}

void MdlStart(void)
{
  rtwdemo_async_initialize();
}

void MdlTerminate(void)
{
  rtwdemo_async_terminate();
}

/* Registration function */
RT_MODEL_rtwdemo_async_T *rtwdemo_async(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)rtwdemo_async_M, 0,
                sizeof(RT_MODEL_rtwdemo_async_T));

  /* Initialize timing info */
  {
    int_T *mdlTsMap = rtwdemo_async_M->Timing.sampleTimeTaskIDArray;
    mdlTsMap[0] = 0;
    mdlTsMap[1] = 1;
    rtwdemo_async_M->Timing.sampleTimeTaskIDPtr = (&mdlTsMap[0]);
    rtwdemo_async_M->Timing.sampleTimes =
      (&rtwdemo_async_M->Timing.sampleTimesArray[0]);
    rtwdemo_async_M->Timing.offsetTimes =
      (&rtwdemo_async_M->Timing.offsetTimesArray[0]);

    /* task periods */
    rtwdemo_async_M->Timing.sampleTimes[0] = (0.016666666666666666);
    rtwdemo_async_M->Timing.sampleTimes[1] = (0.05);

    /* task offsets */
    rtwdemo_async_M->Timing.offsetTimes[0] = (0.0);
    rtwdemo_async_M->Timing.offsetTimes[1] = (0.0);
  }

  rtmSetTPtr(rtwdemo_async_M, &rtwdemo_async_M->Timing.tArray[0]);

  {
    int_T *mdlSampleHits = rtwdemo_async_M->Timing.sampleHitArray;
    int_T *mdlPerTaskSampleHits = rtwdemo_async_M->Timing.perTaskSampleHitsArray;
    rtwdemo_async_M->Timing.perTaskSampleHits = (&mdlPerTaskSampleHits[0]);
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    mdlSampleHits[0] = 1;
    rtwdemo_async_M->Timing.sampleHits = (&mdlSampleHits[0]);
  }

  rtmSetTFinal(rtwdemo_async_M, 0.5);
  rtwdemo_async_M->Timing.stepSize0 = 0.016666666666666666;
  rtwdemo_async_M->Timing.stepSize1 = 0.05;
  rtwdemo_async_M->solverInfoPtr = (&rtwdemo_async_M->solverInfo);
  rtwdemo_async_M->Timing.stepSize = (0.016666666666666666);
  rtsiSetFixedStepSize(&rtwdemo_async_M->solverInfo, 0.016666666666666666);
  rtsiSetSolverMode(&rtwdemo_async_M->solverInfo, SOLVER_MODE_MULTITASKING);

  /* block I/O */
  rtwdemo_async_M->blockIO = ((void *) &rtwdemo_async_B);
  (void) memset(((void *) &rtwdemo_async_B), 0,
                sizeof(B_rtwdemo_async_T));

  /* states (dwork) */
  rtwdemo_async_M->dwork = ((void *) &rtwdemo_async_DW);
  (void) memset((void *)&rtwdemo_async_DW, 0,
                sizeof(DW_rtwdemo_async_T));

  /* external inputs */
  rtwdemo_async_M->inputs = (((void*)&rtwdemo_async_U));
  (void)memset(&rtwdemo_async_U, 0, sizeof(ExtU_rtwdemo_async_T));

  /* external outputs */
  rtwdemo_async_M->outputs = (&rtwdemo_async_Y);
  (void) memset((void *)&rtwdemo_async_Y, 0,
                sizeof(ExtY_rtwdemo_async_T));

  /* Initialize Sizes */
  rtwdemo_async_M->Sizes.numContStates = (0);/* Number of continuous states */
  rtwdemo_async_M->Sizes.numY = (3);   /* Number of model outputs */
  rtwdemo_async_M->Sizes.numU = (60);  /* Number of model inputs */
  rtwdemo_async_M->Sizes.sysDirFeedThru = (1);/* The model is direct feedthrough */
  rtwdemo_async_M->Sizes.numSampTimes = (2);/* Number of sample times */
  rtwdemo_async_M->Sizes.numBlocks = (20);/* Number of blocks */
  rtwdemo_async_M->Sizes.numBlockIO = (7);/* Number of block outputs */
  return rtwdemo_async_M;
}

/*========================================================================*
 * End of Classic call interface                                          *
 *========================================================================*/

The order of these operations is important. Before the code generator enables the interrupt that
activates the task, it must spawn the task.

Review Task and Task Synchronization Code

In the generated source file rtwdemo_async.c, review the task and task synchronization code.

The code generator produces the code for function Task0 from the Task Sync block. That function
includes a small amount of interrupt-level code and runs as an RTOS task.
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The task waits in an infinite for loop until the system releases a synchronization semaphore. If the
system releases the semaphore, the function updates its task timer and calls the code generated for
the Algorithm subsystem.

In the example model, the Synchronize the data transfer of this task with the caller task
parameter for the Task Sync block is set. This parameter setting updates the timer associated with
the Task Sync block (rtM->Timing.clockTick2) with the value of the timer that the Async
Interrupt block (rtM->Timing.clockTick3) maintains. As a result, code for blocks within the
Algorithm subsystem use timer values that are based on the time of the most recent interrupt,
rather than the most recent activation of Task0.

{
  /* Wait for semaphore to be released by system: rtwdemo_async/Task Sync */
  for (;;) {
    if (semTake(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID,NO_WAIT) !=
        ERROR) {
      logMsg("Rate for Task Task0() too fast.\n",0,0,0,0,0,0);

#if STOPONOVERRUN

      logMsg("Aborting real-time simulation.\n",0,0,0,0,0,0);
      semGive(stopSem);
      return(ERROR);

#endif

    } else {
      semTake(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID, WAIT_FOREVER);
    }

    /* Use the upstream clock tick counter for this Task. */
    rtwdemo_async_M->Timing.clockTick2 = rtwdemo_async_M->Timing.clockTick4;

    /* Call the system: '<Root>/Algorithm' */
    {
      int32_T i;
      int32_T i_0;

      /* RateTransition: '<Root>/Protected RT1' */
      i = rtwdemo_async_DW.ProtectedRT1_ActiveBufIdx * 60;
      for (i_0 = 0; i_0 < 60; i_0++) {
        rtwdemo_async_B.ProtectedRT1[i_0] =
          rtwdemo_async_DW.ProtectedRT1_Buffer[i_0 + i];
      }

      /* End of RateTransition: '<Root>/Protected RT1' */

      /* S-Function (vxtask1): '<S5>/S-Function' */

      /* Output and update for function-call system: '<Root>/Algorithm' */
      {
        int32_T i;
        rtwdemo_async_M->Timing.clockTick2 = rtwdemo_async_M->Timing.clockTick4;
        if (rtwdemo_async_DW.Algorithm_RESET_ELAPS_T) {
          rtwdemo_async_DW.Algorithm_ELAPS_T = 0U;
        } else {
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          rtwdemo_async_DW.Algorithm_ELAPS_T =
            rtwdemo_async_M->Timing.clockTick2 -
            rtwdemo_async_DW.Algorithm_PREV_T;
        }

        rtwdemo_async_DW.Algorithm_PREV_T = rtwdemo_async_M->Timing.clockTick2;
        rtwdemo_async_DW.Algorithm_RESET_ELAPS_T = false;

        /* DiscreteIntegrator: '<S1>/Integrator' */
        if (rtwdemo_async_DW.Integrator_SYSTEM_ENABLE == 0) {
          /* DiscreteIntegrator: '<S1>/Integrator' */
          rtwdemo_async_DW.Integrator_DSTATE += 0.016666666666666666 * (real_T)
            rtwdemo_async_DW.Algorithm_ELAPS_T
            * rtwdemo_async_DW.Integrator_PREV_U;
        }

        /* End of DiscreteIntegrator: '<S1>/Integrator' */

        /* Outport: '<Root>/Out3' incorporates:
         *  SignalConversion generated from: '<S1>/Out2'
         */
        rtwdemo_async_Y.Out3 = rtwdemo_async_DW.Integrator_DSTATE;

        /* Sum: '<S1>/Sum1' */
        rtwdemo_async_DW.Integrator_PREV_U = -0.0;
        for (i = 0; i < 60; i++) {
          /* Sum: '<S1>/Sum' incorporates:
           *  Constant: '<S1>/Offset'
           */
          rtwdemo_async_B.Sum[i] = rtwdemo_async_B.ProtectedRT1[i] + 1.25;

          /* Sum: '<S1>/Sum1' */
          rtwdemo_async_DW.Integrator_PREV_U += rtwdemo_async_B.Sum[i];
        }

        /* Update for DiscreteIntegrator: '<S1>/Integrator' */
        rtwdemo_async_DW.Integrator_SYSTEM_ENABLE = 0U;
      }

      /* End of Outputs for S-Function (vxtask1): '<S5>/S-Function' */

      /* RateTransition: '<Root>/Protected RT2' */
      for (i = 0; i < 60; i++) {
        rtwdemo_async_DW.ProtectedRT2_Buffer[i +
          (rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx == 0) * 60] =
          rtwdemo_async_B.Sum[i];
      }

      rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx = (int8_T)
        (rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx == 0);

      /* End of RateTransition: '<Root>/Protected RT2' */
    }
  }
}

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
void isr_num1_vec192(void)
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{
  int_T lock;
  FP_CONTEXT context;

  /* Use tickGet()  as a portable tick
     counter example. A much higher resolution can
     be achieved with a hardware counter */
  rtwdemo_async_M->Timing.clockTick3 = tickGet();

  /* disable interrupts (system is configured as non-preemptive) */
  lock = intLock();

  /* save floating point context */
  fppSave(&context);

  /* Call the system: '<Root>/Count' */
  {
    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* Output and update for function-call system: '<Root>/Count' */
    if (rtwdemo_async_DW.Count_RESET_ELAPS_T) {
      rtwdemo_async_DW.Count_ELAPS_T = 0U;
    } else {
      rtwdemo_async_DW.Count_ELAPS_T = rtwdemo_async_M->Timing.clockTick3 -
        rtwdemo_async_DW.Count_PREV_T;
    }

    rtwdemo_async_DW.Count_PREV_T = rtwdemo_async_M->Timing.clockTick3;
    rtwdemo_async_DW.Count_RESET_ELAPS_T = false;

    /* DiscreteIntegrator: '<S2>/Integrator' */
    if (rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h == 0) {
      /* DiscreteIntegrator: '<S2>/Integrator' */
      rtwdemo_async_DW.Integrator_DSTATE_l += 0.016666666666666666 * (real_T)
        rtwdemo_async_DW.Count_ELAPS_T * rtwdemo_async_DW.Integrator_PREV_U_o;
    }

    /* End of DiscreteIntegrator: '<S2>/Integrator' */

    /* Outport: '<Root>/Out1' incorporates:
     *  SignalConversion generated from: '<S2>/Out'
     */
    rtwdemo_async_Y.Out1 = rtwdemo_async_DW.Integrator_DSTATE_l;

    /* Update for DiscreteIntegrator: '<S2>/Integrator' incorporates:
     *  Constant: '<S2>/Constant'
     */
    rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h = 0U;
    rtwdemo_async_DW.Integrator_PREV_U_o = 1.0;

    /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }

  /* restore floating point context */
  fppRestore(&context);

  /* re-enable interrupts */
  intUnlock(lock);
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}

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
void isr_num2_vec193(void)
{
  /* Use tickGet()  as a portable tick
     counter example. A much higher resolution can
     be achieved with a hardware counter */
  rtwdemo_async_M->Timing.clockTick4 = tickGet();

  /* Call the system: '<S4>/Subsystem' */
  {
    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* Output and update for function-call system: '<S4>/Subsystem' */

    /* S-Function (vxtask1): '<S5>/S-Function' */

    /* VxWorks Task Block: '<S5>/S-Function' (vxtask1) */
    /* Release semaphore for system task: Task0 */
    semGive(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID);

    /* End of Outputs for S-Function (vxtask1): '<S5>/S-Function' */

    /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }
}

The code generator produces code for ISRs isr_num1_vec192 and isr_num2_vec293. ISR
isr_num2_vec192:

• Disables interrupts.
• Saves floating-point context.
• Calls the code generated for the subsystem that connects to the referenced model Inport block,

which receives the interrupt.
• Restores floating-point context.
• Reenables interrupts.

void isr_num1_vec192(void)
{
  int_T lock;
  FP_CONTEXT context;

  /* Use tickGet()  as a portable tick
     counter example. A much higher resolution can
     be achieved with a hardware counter */
  rtwdemo_async_M->Timing.clockTick3 = tickGet();

  /* disable interrupts (system is configured as non-preemptive) */
  lock = intLock();

  /* save floating point context */
  fppSave(&context);
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  /* Call the system: '<Root>/Count' */
  {
    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* Output and update for function-call system: '<Root>/Count' */
    if (rtwdemo_async_DW.Count_RESET_ELAPS_T) {
      rtwdemo_async_DW.Count_ELAPS_T = 0U;
    } else {
      rtwdemo_async_DW.Count_ELAPS_T = rtwdemo_async_M->Timing.clockTick3 -
        rtwdemo_async_DW.Count_PREV_T;
    }

    rtwdemo_async_DW.Count_PREV_T = rtwdemo_async_M->Timing.clockTick3;
    rtwdemo_async_DW.Count_RESET_ELAPS_T = false;

    /* DiscreteIntegrator: '<S2>/Integrator' */
    if (rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h == 0) {
      /* DiscreteIntegrator: '<S2>/Integrator' */
      rtwdemo_async_DW.Integrator_DSTATE_l += 0.016666666666666666 * (real_T)
        rtwdemo_async_DW.Count_ELAPS_T * rtwdemo_async_DW.Integrator_PREV_U_o;
    }

    /* End of DiscreteIntegrator: '<S2>/Integrator' */

    /* Outport: '<Root>/Out1' incorporates:
     *  SignalConversion generated from: '<S2>/Out'
     */
    rtwdemo_async_Y.Out1 = rtwdemo_async_DW.Integrator_DSTATE_l;

    /* Update for DiscreteIntegrator: '<S2>/Integrator' incorporates:
     *  Constant: '<S2>/Constant'
     */
    rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h = 0U;
    rtwdemo_async_DW.Integrator_PREV_U_o = 1.0;

    /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }

  /* restore floating point context */
  fppRestore(&context);

  /* re-enable interrupts */
  intUnlock(lock);
}

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */

ISR isr_num2_vec293 maintains a timer that stores the tick count at the time that the interrupt
occurs. After updating the timer, the ISR releases the semaphore that activates Task0.

/* Spawned with priority: 50 */
void Task0(void)
{
  /* Wait for semaphore to be released by system: rtwdemo_async/Task Sync */
  for (;;) {
    if (semTake(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID,NO_WAIT) !=
        ERROR) {
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      logMsg("Rate for Task Task0() too fast.\n",0,0,0,0,0,0);

#if STOPONOVERRUN

      logMsg("Aborting real-time simulation.\n",0,0,0,0,0,0);
      semGive(stopSem);
      return(ERROR);

#endif

    } else {
      semTake(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID, WAIT_FOREVER);
    }

    /* Use the upstream clock tick counter for this Task. */
    rtwdemo_async_M->Timing.clockTick2 = rtwdemo_async_M->Timing.clockTick4;

    /* Call the system: '<Root>/Algorithm' */
    {
      int32_T i;
      int32_T i_0;

      /* RateTransition: '<Root>/Protected RT1' */
      i = rtwdemo_async_DW.ProtectedRT1_ActiveBufIdx * 60;
      for (i_0 = 0; i_0 < 60; i_0++) {
        rtwdemo_async_B.ProtectedRT1[i_0] =
          rtwdemo_async_DW.ProtectedRT1_Buffer[i_0 + i];
      }

      /* End of RateTransition: '<Root>/Protected RT1' */

      /* S-Function (vxtask1): '<S5>/S-Function' */

      /* Output and update for function-call system: '<Root>/Algorithm' */
      {
        int32_T i;
        rtwdemo_async_M->Timing.clockTick2 = rtwdemo_async_M->Timing.clockTick4;
        if (rtwdemo_async_DW.Algorithm_RESET_ELAPS_T) {
          rtwdemo_async_DW.Algorithm_ELAPS_T = 0U;
        } else {
          rtwdemo_async_DW.Algorithm_ELAPS_T =
            rtwdemo_async_M->Timing.clockTick2 -
            rtwdemo_async_DW.Algorithm_PREV_T;
        }

        rtwdemo_async_DW.Algorithm_PREV_T = rtwdemo_async_M->Timing.clockTick2;
        rtwdemo_async_DW.Algorithm_RESET_ELAPS_T = false;

        /* DiscreteIntegrator: '<S1>/Integrator' */
        if (rtwdemo_async_DW.Integrator_SYSTEM_ENABLE == 0) {
          /* DiscreteIntegrator: '<S1>/Integrator' */
          rtwdemo_async_DW.Integrator_DSTATE += 0.016666666666666666 * (real_T)
            rtwdemo_async_DW.Algorithm_ELAPS_T
            * rtwdemo_async_DW.Integrator_PREV_U;
        }

        /* End of DiscreteIntegrator: '<S1>/Integrator' */
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        /* Outport: '<Root>/Out3' incorporates:
         *  SignalConversion generated from: '<S1>/Out2'
         */
        rtwdemo_async_Y.Out3 = rtwdemo_async_DW.Integrator_DSTATE;

        /* Sum: '<S1>/Sum1' */
        rtwdemo_async_DW.Integrator_PREV_U = -0.0;
        for (i = 0; i < 60; i++) {
          /* Sum: '<S1>/Sum' incorporates:
           *  Constant: '<S1>/Offset'
           */
          rtwdemo_async_B.Sum[i] = rtwdemo_async_B.ProtectedRT1[i] + 1.25;

          /* Sum: '<S1>/Sum1' */
          rtwdemo_async_DW.Integrator_PREV_U += rtwdemo_async_B.Sum[i];
        }

        /* Update for DiscreteIntegrator: '<S1>/Integrator' */
        rtwdemo_async_DW.Integrator_SYSTEM_ENABLE = 0U;
      }

      /* End of Outputs for S-Function (vxtask1): '<S5>/S-Function' */

      /* RateTransition: '<Root>/Protected RT2' */
      for (i = 0; i < 60; i++) {
        rtwdemo_async_DW.ProtectedRT2_Buffer[i +
          (rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx == 0) * 60] =
          rtwdemo_async_B.Sum[i];
      }

      rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx = (int8_T)
        (rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx == 0);

      /* End of RateTransition: '<Root>/Protected RT2' */
    }
  }
}

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
void isr_num1_vec192(void)
{
  int_T lock;
  FP_CONTEXT context;

  /* Use tickGet()  as a portable tick
     counter example. A much higher resolution can
     be achieved with a hardware counter */
  rtwdemo_async_M->Timing.clockTick3 = tickGet();

  /* disable interrupts (system is configured as non-preemptive) */
  lock = intLock();

  /* save floating point context */
  fppSave(&context);

  /* Call the system: '<Root>/Count' */
  {
    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
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    /* Output and update for function-call system: '<Root>/Count' */
    if (rtwdemo_async_DW.Count_RESET_ELAPS_T) {
      rtwdemo_async_DW.Count_ELAPS_T = 0U;
    } else {
      rtwdemo_async_DW.Count_ELAPS_T = rtwdemo_async_M->Timing.clockTick3 -
        rtwdemo_async_DW.Count_PREV_T;
    }

    rtwdemo_async_DW.Count_PREV_T = rtwdemo_async_M->Timing.clockTick3;
    rtwdemo_async_DW.Count_RESET_ELAPS_T = false;

    /* DiscreteIntegrator: '<S2>/Integrator' */
    if (rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h == 0) {
      /* DiscreteIntegrator: '<S2>/Integrator' */
      rtwdemo_async_DW.Integrator_DSTATE_l += 0.016666666666666666 * (real_T)
        rtwdemo_async_DW.Count_ELAPS_T * rtwdemo_async_DW.Integrator_PREV_U_o;
    }

    /* End of DiscreteIntegrator: '<S2>/Integrator' */

    /* Outport: '<Root>/Out1' incorporates:
     *  SignalConversion generated from: '<S2>/Out'
     */
    rtwdemo_async_Y.Out1 = rtwdemo_async_DW.Integrator_DSTATE_l;

    /* Update for DiscreteIntegrator: '<S2>/Integrator' incorporates:
     *  Constant: '<S2>/Constant'
     */
    rtwdemo_async_DW.Integrator_SYSTEM_ENABLE_h = 0U;
    rtwdemo_async_DW.Integrator_PREV_U_o = 1.0;

    /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }

  /* restore floating point context */
  fppRestore(&context);

  /* re-enable interrupts */
  intUnlock(lock);
}

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */

Review Task Termination Code

The Task Sync block generates the following termination code.

static void rtwdemo_async_terminate(void)
{
  /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Disable interrupt for ISR system: isr_num1_vec192 */
  sysIntDisable(1);

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
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  /* Disable interrupt for ISR system: isr_num2_vec193 */
  sysIntDisable(2);

  /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

  /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
   *  SubSystem: '<S4>/Subsystem'
   */

  /* Termination for function-call system: '<S4>/Subsystem' */

  /* Terminate for S-Function (vxtask1): '<S5>/S-Function' */

  /* VxWorks Task Block: '<S5>/S-Function' (vxtask1) */
  /* Destroy task: Task0 */
  taskDelete(rtwdemo_async_DW.SFunction_IWORK.TaskID);

  /* End of Terminate for S-Function (vxtask1): '<S5>/S-Function' */

  /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
}

Related Information

• Async Interrupt
• Task Sync
• “Generate Interrupt Service Routines”
• “Timers in Asynchronous Tasks”
• “Create a Customized Asynchronous Library”
• “Import Asynchronous Event Data for Simulation”
• “Load Data to Root-Level Input Ports”
• “Asynchronous Events”
• “Rate Transitions and Asynchronous Blocks”
• “Asynchronous Support Limitations”

See Also

More About
• “Generate Interrupt Service Routines”
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model”
• “Timers in Asynchronous Tasks”
• “Import Asynchronous Event Data for Simulation”
• “Rate Transitions and Asynchronous Blocks”
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Pass Asynchronous Events in RTOS as Input To a Referenced
Model

This example shows how to simulate and generate code for asynchronous events on a real-time
multitasking system.

About the Example Model

Open the example model rtwdemo_async_mdlreftop.

open_system('rtwdemo_async_mdlreftop');

The model simulates an interrupt source and includes an Async Interrupt block and referenced
model. The Async Interrupt block creates two Versa Module Eurocard (VME) interrupt service
routines (ISRs) that pass interrupt signals to Inport blocks 1 and 2 of the referenced model.

You can place an Async Interrupt block between a simulated interrupt source and one of these
model elements:

• Function call subsystem
• Task Sync block
• A Stateflow chart configured for a function call input event
• A referenced model with an Inport block that connects to one of the preceding model elements

In this example model, the Async Interrupt block passes asynchronous events (function-call
trigger signals), Interrupt1 and Interrupt2, to the referenced model through Inport blocks 1
and 2.

The code generator produces code that is tailored for the VxWorks operating system. Reconfigure the
Async Interrupt block to generate code for an alternative application run-time environment.
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Open the referenced model. The referenced model includes the two Inport blocks that receive the
interrupts, each connected to an Asynchronous Task Specification block, function-call
subsystems Count and Algorithm, and Rate Transition blocks. The Asynchronous Task
Specification block, in combination with a root-level Inport block, allows a reference model to
receive asynchronous function-call input. To use the block:

1 Connect the Asynchronous Task Specification block to the output port of the root-level
Inport block that outputs a function-call trigger.

2 Select the Output function call parameter of the Inport block to specify that it accepts
function-call signals.

3 On the parameters dialog box for the Asynchronous Task Specification block, set the task
priority for the asynchronous task associated with an Inport block. Specify an integer or []. If
you specify an integer, it must match the priority of the interrupt initiated by the Async
Interrupt block in the parent model. If you specify [], the priorities do not have to match.

The Asynchronous Task Specification block for the higher priority interrupt, interrupt1,
connect to function-call subsystem Count. Count represents a simple interrupt service routine (ISR).
The second Asynchronous Task Specification block connect to the subsystem Algorithm,
which includes more substance. It includes multiple blocks and produces two output values. Both
subsystems execute at interrupt level.

For each interrupt level specified for the Async Interrupt block in the parent model, the block
generates a VME ISR that executes the connected subsystem, Task Sync block, or chart.

In the example top model, the Async Interrupt block is configured for VME interrupts 1 and 2,
using interrupt vector offsets 192 and 193. Interrupt 1 is wired to trigger subsystem Count.
Interrupt 2 is wired to trigger subsystem Algorithm.

The Rate Transition blocks handle data transfers between ports that operate at different rates. In
two instances, the blocks protect data transfers (prevent them from being preempted and corrupted).
In the other instance, no special behavior occurs.

Data Transfer Assumptions

• Data transfers occur between one reading task and one writing task.
• A read or write operation on a byte-sized variable is atomic.
• When two tasks interact, only one can preempt the other.
• For periodic tasks, the task with the faster rate has higher priority than the task with the slower

rate. The task with the faster rate preempts the tasks with slower rates.
• Tasks run on a single processor. Time slicing is not allowed.
• Processes do not crash and restart, especially while data is being transferred between tasks.

Simulate the Model

Simulate the model. By default, the model is configured to show sample times in different colors.
Discrete sample times for input and output appear red and green, respectively. Constants are
magenta. Asynchronous interrupts are purple. The Rate Transition blocks, which are hybrid
(input and output sample times can differ), appear yellow.
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Generate Code and Report

Generate code and a code generation report for the model. Async Interrupt block and Task Sync
block generated code is for the example RTOS (VxWorks). However, you can modify the blocks to
generate code for another run-time environment.

1. Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

2. Build the model.

slbuild('rtwdemo_async_mdlreftop');

### Starting serial model reference code generation build

Warning: Simulink Coder: The tornado.tlc target will be removed in a future release.

### Successfully updated the model reference code generation target for: rtwdemo_async_mdlrefbot
### Starting build procedure for: rtwdemo_async_mdlreftop

Warning: Simulink Coder: The tornado.tlc target will be removed in a future release.

### Successful completion of code generation for: rtwdemo_async_mdlreftop

Build Summary

Code generation targets built:

Model                    Action          Rebuild Reason                             
====================================================================================
rtwdemo_async_mdlrefbot  Code generated  rtwdemo_async_mdlrefbot.c does not exist.  

Top model targets built:

Model                    Action          Rebuild Reason                                    
===========================================================================================
rtwdemo_async_mdlreftop  Code generated  Code generation information file does not exist.  

2 of 2 models built (0 models already up to date)
Build duration: 0h 0m 46.966s

Review Initialization Code

Open the generated source file rtwdemo_async_mdlreftop.c. The initialization code connects and
enables ISR isr_num1_vec192 for interrupt 1 and ISR isr_num2_vec193 for interrupt 2.

cfile = fullfile(cgDir, 'rtwdemo_async_mdlreftop_tornado_rtw', 'rtwdemo_async_mdlreftop.c');
rtwdemodbtype(cfile, ...
    'static void rtwdemo_async_mdlreftop_initialize(void)', ...
    '/* Model terminate function */', ... 
    1, 0);

static void rtwdemo_async_mdlreftop_initialize(void)
{
  /* Start for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
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  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Connect and enable ISR function: isr_num1_vec192 */
  if (intConnect(INUM_TO_IVEC(192), isr_num1_vec192, 0) != OK) {
    printf("intConnect failed for ISR 1.\n");
  }

  sysIntEnable(1);

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Connect and enable ISR function: isr_num2_vec193 */
  if (intConnect(INUM_TO_IVEC(193), isr_num2_vec193, 0) != OK) {
    printf("intConnect failed for ISR 2.\n");
  }

  sysIntEnable(2);

  /* End of Start for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

  /* SystemInitialize for ModelReference: '<Root>/Model' incorporates:
   *  Inport: '<Root>/In1_60hz'
   *  Inport: '<Root>/In2_60_hz'
   *  Inport: '<Root>/In3_60hz'
   *  Outport: '<Root>/Out1'
   *  Outport: '<Root>/Out2'
   *  Outport: '<Root>/Out3'
   */
  rtwdemo_async_mdlrefbot_Init(&rtwdemo_async_mdlreftop_Y.Out1);
  rtwdemo_async_mdlrefbot_Enable();
}

Review ISR Code

In the generated source file rtwdemo_async_mdlreftop.c, review the code for ISRs
isr_num1_vec192 and isr_num2_vec293. Each ISR:

• Disables interrupts.
• Saves floating-point context.
• Calls the code generated for the subsystem connected to the referenced model Inport block that

receives the interrupt.
• Restores floating-point context.
• Reenables interrupts.

cfile = fullfile(cgDir, 'rtwdemo_async_mdlreftop_tornado_rtw', 'rtwdemo_async_mdlreftop.c');
rtwdemodbtype(cfile, ...
    'void isr_num1_vec192(void)', ...
    'time_T rt_SimUpdateDiscreteEvents', ... 
    1, 0);

void isr_num1_vec192(void)
{
  int_T lock;
  FP_CONTEXT context;

  /* disable interrupts (system is configured as non-preemptive) */
  lock = intLock();
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  /* save floating point context */
  fppSave(&context);

  /* Call the system: '<Root>/Model' */
  {
    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* ModelReference: '<Root>/Model' incorporates:
     *  Inport: '<Root>/In1_60hz'
     *  Inport: '<Root>/In2_60_hz'
     *  Inport: '<Root>/In3_60hz'
     *  Outport: '<Root>/Out1'
     *  Outport: '<Root>/Out2'
     *  Outport: '<Root>/Out3'
     */
    rtwdemo_async_mdlrefbot_Interrupt1(&rtwdemo_async_mdlreftop_Y.Out1);

    /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }

  /* restore floating point context */
  fppRestore(&context);

  /* re-enable interrupts */
  intUnlock(lock);
}

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
void isr_num2_vec193(void)
{
  FP_CONTEXT context;

  /* save floating point context */
  fppSave(&context);

  /* Call the system: '<Root>/Model' */
  {
    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* ModelReference: '<Root>/Model' incorporates:
     *  Inport: '<Root>/In1_60hz'
     *  Inport: '<Root>/In2_60_hz'
     *  Inport: '<Root>/In3_60hz'
     *  Outport: '<Root>/Out1'
     *  Outport: '<Root>/Out2'
     *  Outport: '<Root>/Out3'
     */
    rtwdemo_async_mdlrefbot_Interrupt2();

    /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
  }

  /* restore floating point context */
  fppRestore(&context);
}
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Review Task Termination Code

The Task Sync block generates the following termination code.

cfile = fullfile(cgDir, 'rtwdemo_async_mdlreftop_tornado_rtw', 'rtwdemo_async_mdlreftop.c');
rtwdemodbtype(cfile, ...
    'static void rtwdemo_async_mdlreftop_terminate(void)', ...
    '/*========================================================================*', ... 
    1, 0);

static void rtwdemo_async_mdlreftop_terminate(void)
{
  /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Disable interrupt for ISR system: isr_num1_vec192 */
  sysIntDisable(1);

  /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
  /* Disable interrupt for ISR system: isr_num2_vec193 */
  sysIntDisable(2);

  /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
}

Related Information

• Async Interrupt
• Asynchronous Task Specification
• “Generate Interrupt Service Routines”
• “Timers in Asynchronous Tasks”
• “Create a Customized Asynchronous Library”
• “Import Asynchronous Event Data for Simulation”
• “Load Data to Root-Level Input Ports”
• “Asynchronous Events”
• “Rate Transitions and Asynchronous Blocks”
• “Asynchronous Support Limitations”

bdclose('rtwdemo_async_mdlreftop');
rtwdemoclean;
cd(currentDir)

See Also

More About
• “Generate Interrupt Service Routines”
• “Spawn and Synchronize Execution of RTOS Task”
• “Timers in Asynchronous Tasks”
• “Import Asynchronous Event Data for Simulation”
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• “Rate Transitions and Asynchronous Blocks”

29 Event-Based Scheduling in Simulink Coder

29-34



Rate Transitions and Asynchronous Blocks
Because an asynchronous function call subsystem can preempt or be preempted by other model code,
an inconsistency arises when more than one signal element is connected to an asynchronous block.
The issue is that signals passed to and from the function call subsystem can be in the process of being
written to or read from when the preemption occurs. Thus, some old and some new data is used. This
situation can also occur with scalar signals in some cases. For example, if a signal is a double (8
bytes), the read or write operation might require two machine instructions.

Note The operating system integration techniques that are demonstrated in this section use one or
more blocks the blocks in the vxlib1 library. These blocks provide starting point examples to help
you develop custom blocks for your target environment.

About Rate Transitions and Asynchronous Blocks
The Simulink Rate Transition block is designed to deal with preemption problems that occur in data
transfer between blocks running at different rates. These issues are discussed in “Time-Based
Scheduling and Code Generation”.

You can handle rate transition issues automatically by selecting model configuratoin parameter
Automatically handle rate transition for data transfer. This saves you from having to manually
insert Rate Transition blocks to avoid invalid rate transitions, including invalid asynchronous-to-
periodic and asynchronous-to-asynchronous rate transitions, in multirate models. For asynchronous
tasks, the Simulink engine configures inserted blocks for data integrity but not determinism during
data transfers.

For asynchronous rate transitions, the Rate Transition block provides data integrity, but cannot
provide determinism. Therefore, when you insert Rate Transition blocks explicitly, you must clear the
block parameter Ensure deterministic data transfer (maximum delay).

When you insert a Rate Transition block between two blocks to maintain data integrity and priorities
are assigned to the tasks associated with the blocks, the code generator assumes that the higher
priority task can preempt the lower priority task and the lower priority task cannot preempt the
higher priority task. If the priority associated with task for either block is not assigned or the
priorities of the tasks for both blocks are the same, the code generator assumes that either task can
preempt the other task.

Priorities of periodic tasks are assigned by the Simulink engine, in accordance with the parameters
specified in the Solver selection section of the Solver pane of the Configuration Parameters dialog
box. When the Periodic sample time constraint parameter is set to Unconstrained, the model
base rate priority is set to 40. Priorities for subrates then increment or decrement by 1 from the base
rate priority, depending on the setting of parameter Higher priority value indicates higher task
priority.

You can assign priorities manually by using parameter Periodic sample time properties. The
Simulink engine does not assign a priority to asynchronous blocks. For example, the priority of a
function call subsystem that connects back to an Async Interrupt block is assigned by the Async
Interrupt block.

Block parameter Simulink task priority of the Async Interrupt block specifies a priority level
(required) for every interrupt number entered for parameter VME interrupt number(s). The
priority array sets the priorities of the subsystems connected to each interrupt.
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For the Task Sync block, if the example RTOS (VxWorks) is the target, clear block parameter Higher
priority value indicates higher task priority. Parameter Simulink task priority specifies the
block priority relative to connected blocks (in addition to assigning an RTOS priority to the generated
task code).

The vxlib1 library provides two types of rate transition blocks as a convenience. These are simply
preconfigured instances of the built-in Simulink Rate Transition block:

• Protected Rate Transition block: Rate Transition block that is configured with block parameter
Ensure data integrity during data transfers selected and Ensure deterministic data
transfer cleared.

• Unprotected Rate Transition block: Rate Transition block that is configured with the Ensure data
integrity during data transfers cleared.

Handle Rate Transitions for Asynchronous Tasks
For rate transitions that involve asynchronous tasks, you can maintain data integrity. However, you
cannot achieve determinism. You have the option of using the Rate Transition block or target-specific
rate transition blocks.

Consider the following model, which includes a Rate Transition block.

You can use the Rate Transition block in either of the following modes:

• Maintain data integrity, no determinism
• Unprotected

Alternatively, you can use target-specific rate transition blocks. The following blocks are available for
the example RTOS (VxWorks):

• Protected Rate Transition block (reader)
• Protected Rate Transition block (writer)
• Unprotected Rate Transition block

Handle Multiple Asynchronous Interrupts
Consider the following model, in which two functions trigger the same subsystem.
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The two tasks must have equal priorities. When priorities are the same, the outcome depends on
whether they are firing periodically or asynchronously, and also on a diagnostic setting. The following
table and notes describe these outcomes:

Supported Sample Time and Priority for Function Call Subsystem with Multiple Triggers

 Async Priority =
1

Async Priority =
2

Async Priority
Unspecified

Periodic Priority
= 1

Periodic Priority
= 2

Async Priority =
1

Supported (1)     

Async Priority =
2

 Supported (1)    

Async Priority
Unspecified

  Supported (2)   

Periodic Priority
= 1

   Supported  

Periodic Priority
= 2

    Supported

1 Control these outcomes by using model configuratoin parameter Tasks with equal priority ; set
this diagnostic to none if tasks of equal priority cannot preempt each other in the target system.

2 For this case, the following warning message is issued unconditionally:

The function call subsystem <name> has multiple asynchronous 
triggers that do not specify priority. Data integrity will 
not be maintained if these triggers can preempt one another.

Empty cells in the above table represent multiple triggers with differing priorities, which are
unsupported.

The code generator provides absolute time management for a function call subsystem connected to
multiple interrupts in the case where timer settings for TriggerA and TriggerB (time source,
resolution) are the same.

Assume that all of the following conditions are true for the model shown above:

• A function call subsystem is triggered by two asynchronous triggers (TriggerA and TriggerB)
having identical priority settings.

• Each trigger sets the source of time and timer attributes by calling the functions
ssSetTimeSource and ssSetAsyncTimerAttributes.
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• The triggered subsystem contains a block that needs elapsed or absolute time (for example, a
Discrete Time Integrator).

The asynchronous function call subsystem has one global variable, clockTick# (where # is the task
ID associated with the subsystem). This variable stores absolute time for the asynchronous task.
There are two ways timing can be handled:

• If the time source is set to SS_TIMESOURCE_BASERATE, the code generator produces timer code
in the function call subsystem, updating the clock tick variable from the base rate clock tick. Data
integrity is maintained if the same priority is assigned to TriggerA and TriggerB.

• If the time source is SS_TIMESOURCE_SELF, generated code for both TriggerA and TriggerB
updates the same clock tick variable from the hardware clock.

The word size of the clock tick variable can be set directly or be established according to setting of
model configuration parameter Application lifespan (days) and the timer resolution set by the
TriggerA and TriggerB S-functions (which must be the same). See “Timers in Asynchronous Tasks” on
page 29-39 and “Control Memory Allocation for Time Counters” on page 69-10 for more
information.

Protect Data Integrity with volatile Keyword
When you select block parameter Ensure data integrity during data transfer, the code generated
for a Rate Transition block defines volatile global buffers and semaphores and uses them to
protect the integrity of the transferred data. For additional protection, or for protection without a
Rate Transition block, you can explicitly apply volatile to the transferred data. For more
information, see “Protect Global Data with const and volatile Type Qualifiers” on page 43-13.

See Also

More About
• “Handle Rate Transitions”
• “Time-Based Scheduling and Code Generation”
• “Asynchronous Support Limitations”
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Timers in Asynchronous Tasks
An ISR can set a source for absolute time. This is done with the function ssSetTimeSource. The
function ssSetTimeSource cannot be called before ssSetOutputPortWidth is called. If this
occurs, the program will come to a halt and generate an error message. ssSetTimeSource has the
following three options:

• SS_TIMESOURCE_SELF: Each generated ISR maintains its own absolute time counter, which is
distinct from a periodic base rate or subrate counters in the system. The counter value and the
timer resolution value (specified with the block parameter Timer resolution (seconds) of the
Async Interrupt block) are used by downstream blocks to determine absolute time values required
by block computations.

• SS_TIMESOURCE_CALLER: The ISR reads time from a counter maintained by its caller. Time
resolution is thus the same as its caller's resolution.

• SS_TIMESOURCE_BASERATE: The ISR can read absolute time from the model's periodic base rate.
Time resolution is thus the same as its base rate resolution.

Note The operating system integration techniques that are demonstrated in this section use one or
more blocks the blocks in the vxlib1 library. These blocks provide starting point examples to help
you develop custom blocks for your target environment.

By default, the counter is implemented as a 32-bit unsigned integer member of the Timing
substructure of the real-time model structure. For a target that supports the rtModel data structure,
when the time data type is not set by using ssSetAsyncTimeDataType, the counter word size is
determined by the setting for model configuration parameter Application lifespan (days). As an
example (from ERT target code),

/* Real-time Model Data Structure */
struct _RT_MODEL_elapseTime_exp_Tag {
   const char *errorStatus;
  
  /*
   * Timing:
   * The following substructure contains information regarding
   * the timing information for the model.
   */
  struct {
    uint32_T clockTick1;
    uint32_T clockTick2;
  } Timing;
};

The example omits unused fields in the Timing data structure (a feature of ERT target code not
found in GRT). For a target that supports the rtModel data structure, the counter word size is
determined by the setting of model configuration parameter Application lifespan (days).

By default, the vxlib1 library blocks for the example RTOS (VxWorks) set the timer source to
SS_TIMESOURCE_SELF and update their counters by using the system call tickGet. tickGet
returns a timer value maintained by the RTOS kernel. The maximum word size for the timer is
UINT32. The following example shows a generated call to tickGet.

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
void isr_num2_vec193(void)
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{

 /* Use tickGet() as a portable tick counter example. A much
    higher resolution can be achieved with a hardware counter */
 rtM->Timing.clockTick2 = tickGet();
. . .

The tickGet call is supplied only as an example. It can (and in many instances should) be replaced
by a timing source that has better resolution. If you are implementing a custom asynchronous block
for an RTOS other than the example RTOS (VxWorks), you should either generate an equivalent call
to the target RTOS, or generate code to read a timer register on the target hardware.

Change the setting for the block parameter Timer resolution (seconds) for your Async Interrupt
block to match the resolution of timing source for you target computer.

The counter is updated at interrupt level. Its value represents the tick value of the timing source at
the most recent execution of the ISR. The rate of this timing source is unrelated to sample rates in
the model. In fact, typically it is faster than the model's base rate. Select the timer source and set its
rate and resolution based on the expected rate of interrupts to be serviced by the Async Interrupt
block.

For an example of timer code generation, see “Async Interrupt Block Implementation” on page 29-
41.

See Also

Related Examples
• “Generate Interrupt Service Routines” on page 29-5
• “Spawn and Synchronize Execution of RTOS Task” on page 29-11
• “Timers in Asynchronous Tasks” on page 29-39
• “Create a Customized Asynchronous Library” on page 29-41
• “Import Asynchronous Event Data for Simulation” on page 29-48

More About
• “Absolute and Elapsed Time Computation”
• “Time-Based Scheduling and Code Generation”
• “Asynchronous Events”
• “Asynchronous Support Limitations”

29 Event-Based Scheduling in Simulink Coder

29-40



Create a Customized Asynchronous Library
This topic describes how to implement asynchronous blocks for use with your target RTOS, using the
Async Interrupt and Task Sync blocks as a starting point. Rate Transition blocks are target-
independent, so you do not need to develop customized rate transition blocks.

Note The operating system integration techniques that are demonstrated in this section use one or
more blocks the blocks in the vxlib1 library. These blocks provide starting point examples to help
you develop custom blocks for your target environment.

About Implementing Asynchronous Blocks
You can customize the asynchronous library blocks by modifying the block implementation. These
files are

• The block's underlying S-function MEX-file
• The TLC files that control code generation of the block

In addition, you need to modify the block masks to remove references specific to the example RTOS
(VxWorks) and to incorporate parameters required by your target RTOS.

Custom block implementation is an advanced topic, requiring familiarity with the Simulink MEX S-
function format and API, and with the Target Language Compiler (TLC). These topics are covered in
the following documents:

• Simulink topics “What Is an S-Function?”, “Use S-Functions in Models”, “How S-Functions Work”,
and “Implementing S-Functions” describe MEX S-functions and the S-function API in general.

• The “Inlining S-Functions”, “Inline C MEX S-Functions”, and “S-Functions and Code Generation”
describe how to create a TLC block implementation for use in code generation.

The following sections discuss the C/C++ and TLC implementations of the asynchronous library
blocks, including required SimStruct macros and functions in the TLC asynchronous support library
(asynclib.tlc).

Async Interrupt Block Implementation
The source files for the Async Interrupt block are located in matlabroot/rtw/c/tornado/
devices (open):

• vxinterrupt1.c: C MEX-file source code, for use in configuration and simulation
• vxinterrupt1.tlc: TLC implementation, for use in code generation
• asynclib.tlc: library of TLC support functions, called by the TLC implementation of the block.

The library calls are summarized in “asynclib.tlc Support Library” on page 29-46.

C MEX Block Implementation

Most of the code in vxinterrupt1.c performs ordinary functions that are not related to
asynchronous support (for example, obtaining and validating parameters from the block mask,
marking parameters nontunable, and passing parameter data to the model.rtw file).
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The mdlInitializeSizes function uses special SimStruct macros and SS_OPTIONS settings that
are required for asynchronous blocks, as described below.

Note that the following macros cannot be called before ssSetOutputPortWidth is called:

• ssSetTimeSource
• ssSetAsyncTimerAttributes
• ssSetAsyncTimerResolutionEl
• ssSetAsyncTimerDataType
• ssSetAsyncTimerDataTypeEl
• ssSetAsyncTaskPriorities
• ssSetAsyncTaskPrioritiesEl

If one of the above macros is called before ssSetOutputPortWidth, the following error message
appears:

SL_SfcnMustSpecifyPortWidthBfCallSomeMacro {  
S-function '%s' in '%<BLOCKFULLPATH>'
must set output port %d width using
ssSetOutputPortWidth before calling macro %s
 }

ssSetAsyncTimerAttributes

ssSetAsyncTimerAttributes declares that the block requires a timer, and sets the resolution of
the timer as specified for block parameter Timer resolution (seconds).

The function prototype is

ssSetAsyncTimerAttributes(SimStruct *S, double res)

where

• S is a Simstruct pointer.
• Parameter Timer resolution (seconds) is set to res.

The following code excerpt shows the call to ssSetAsyncTimerAttributes.

/* Setup Async Timer attributes */
ssSetAsyncTimerAttributes(S,mxGetPr(TICK_RES)[0]);

ssSetAsyncTaskPriorities

ssSetAsyncTaskPriorities sets the Simulink task priority for blocks executing at each interrupt
level, as specified for block parameter Simulink task priority.

The function prototype is

ssSetAsyncTaskPriorities(SimStruct *S, int numISRs, 
                         int *priorityArray)

where

• S is a SimStruct pointer.
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• numISRs is the number of interrupts specified for block parameter VME interrupt number(s) .
• priorityarray is an integer array containing the interrupt numbers specified for block

parameter VME interrupt number(s).

The following code excerpt shows the call to ssSetAsyncTaskPriorities:

/* Setup Async Task Priorities */
    priorityArray = malloc(numISRs*sizeof(int_T));
    for (i=0; i<numISRs; i++) {
        priorityArray[i] = (int_T)(mxGetPr(ISR_PRIORITIES)[i]);
    }
    ssSetAsyncTaskPriorities(S, numISRs, priorityArray); 
    free(priorityArray);
    priorityArray = NULL;
}

SS_OPTION Settings

The code excerpt below shows the SS_OPTION settings for vxinterrupt1.c.
SS_OPTION_ASYNCHRONOUS_INTERRUPT should be used when a function call subsystem is attached
to an interrupt. For more information, see the documentation for SS_OPTION and
SS_OPTION_ASYNCHRONOUS in matlabroot/simulink/include/simstruc.h.

ssSetOptions( S, (SS_OPTION_EXCEPTION_FREE_CODE |
              SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME |
              SS_OPTION_ASYNCHRONOUS_INTERRUPT |

If an S-function specifies the SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME option and inherits a
sample time of Inf, the code generator determines how to produce code for the block based on
whether the block is invariant. A block is invariant if its port signals are invariant. A signal is
invariant if it has a constant value during the entire simulation. If you specify a Constant block
sample time, do not assume that the port signals are invariant. For more information, see “Inline
Invariant Signals”. If the block is not invariant, the code generator produces code only in the initialize
entry-point function. If the block is invariant, the code generator does not produce code for the block.

TLC Implementation

This section discusses each function of vxinterrupt1.tlc, with an emphasis on target-specific
features that you will need to change to generate code for your target RTOS.

Generate #include Directives

vxinterrupt1.tlc begins with the statement

%include "vxlib.tlc"

vxlib.tlc is a target-specific file that generates directives to include header files for the example
RTOS (VxWorks). You should replace this with a file that generates includes for your target RTOS.

BlockInstanceSetup Function

For each connected output of the Async Interrupt block, BlockInstanceSetup defines a function
name for the corresponding ISR in the generated code. The functions names are of the form

isr_num_vec_offset
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where num is the ISR number defined for block parameter VME interrupt number(s), and offset
is an interrupt table offset defined by block parameter VME interrupt vector offset(s).

In a custom implementation, this naming convention is optional.

The function names are cached for use by the Outputs function, which generates the actual ISR
code.
Outputs Function

Outputs iterates over the connected outputs of the Async Interrupt block. An ISR is generated for
each such output.

The ISR code is cached in the "Functions" section of the generated code. Before generating the
ISR, Outputs does the following:

• Generates a call to the downstream block (cached in a temporary buffer).
• Determines whether the ISR should be locked or not (as specified by block parameter

Preemption Flag(s)).
• Determines whether the block connected to the Async Interrupt block is a Task Sync block. (This

information is obtained by using the asynclib calls LibGetFcnCallBlock and
LibGetBlockAttribute.) If so,

• The preemption flag for the ISR must be set to 1. An error results otherwise.
• The RTOS (VxWorks) calls to save and restore floating-point context are generated, unless the

user has configured the model for integer-only code generation.

When generating the ISR code, Outputs calls the asynclib function LibNeedAsyncCounter to
determine whether a timer is required by the connected subsystem. If so, and if the time source is set
to be SS_TIMESOURCE_SELF by ssSetTimeSource, LibSetAsyncCounter is called to generate an
RTOS (VxWorks) tickGet function call and update the counter. In your implementation, you should
generate either an equivalent call to the target RTOS, or generate code to read the a timer register
on the target hardware.
Start Function

The Start function generates the required RTOS (VxWorks) calls (int_connect and
sysInt_Enable) to connect and enable each ISR. You should replace this with calls to your target
RTOS.
Terminate Function

The Terminate function generates the call sysIntDisable to disable each ISR. You should replace
this with calls to your target RTOS.

Task Sync Block Implementation
The source files for the Task Sync block are located in matlabroot/rtw/c/tornado/devices
(open). They are

• vxtask1.cpp: MEX-file source code, for use in configuration and simulation.
• vxtask1.tlc: TLC implementation, for use in code generation.
• asynclib.tlc: library of TLC support functions, called by the TLC implementation of the block.

The library calls are summarized in “asynclib.tlc Support Library” on page 29-46.
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C MEX Block Implementation

Like the Async Interrupt block, the Task Sync block sets up a timer, in this case with a fixed
resolution. The priority of the task associated with the block is obtained from block parameter
Simulink task priority. The SS_OPTION settings are the same as those used for the Async Interrupt
block.

ssSetAsyncTimerAttributes(S, 0.01);

priority  = (int_T) (*(mxGetPr(PRIORITY)));
ssSetAsyncTaskPriorities(S,1,&priority);

ssSetOptions(S, (SS_OPTION_EXCEPTION_FREE_CODE |
                 SS_OPTION_ASYNCHRONOUS |
                 SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME |
}

TLC Implementation
Generate #include Directives

vxtask1.tlc begins with the statement

%include "vxlib.tlc"

vxlib.tlc is a target-specific file that generates directives to include header files for the example
RTOS (VxWorks). You should replace this with a file that generates includes for your target RTOS.

BlockInstanceSetup Function

The BlockInstanceSetup function derives the task name, block name, and other identifiers used
later in code generation. It also checks for and warns about unconnected block conditions, and
generates a storage declaration for a semaphore (stopSem) that is used in case of interrupt overflow
conditions.

Start Function

The Start function generates the required RTOS (VxWorks) calls to define storage for the
semaphore that is used in management of the task spawned by the Task Sync block. Depending on
the value of the CodeFormat TLC variable of the target, either a static storage declaration or a
dynamic memory allocation call is generated. This function also creates a semaphore (semBCreate)
and spawns an RTOS task (taskSpawn). You should replace these with calls to your target RTOS.

Outputs Function

The Outputs function generates an example RTOS (VxWorks) task that waits for a semaphore. When
it obtains the semaphore, it updates the block's tick timer and calls the downstream subsystem code,
as described in “Spawn and Synchronize Execution of RTOS Task” on page 29-11. Outputs also
generates code (called from interrupt level) that grants the semaphore.

Terminate Function

The Terminate function generates the example RTOS (VxWorks) call taskDelete to end execution
of the task spawned by the block. You should replace this with calls to your target RTOS.

Note also that if the target RTOS has dynamically allocated memory associated with the task, the
Terminate function should deallocate the memory.
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asynclib.tlc Support Library
asynclib.tlc is a library of TLC functions that support the implementation of asynchronous blocks.
Some functions are specifically designed for use in asynchronous blocks. For example,
LibSetAsyncCounter generates a call to update a timer for an asynchronous block. Other functions
are utilities that return information required by asynchronous blocks (for example, information about
connected function call subsystems).

The following table summarizes the public calls in the library. For details, see the library source code
and the vxinterrupt1.tlc and vxtask1.tlc files, which call the library functions.

Summary of asynclib.tlc Library Functions

Function Description
LibBlockExecuteFcnCall For use by inlined S-functions with function call outputs. Generates

code to execute a function call subsystem.
LibGetBlockAttribute Returns a field value from a block record.
LibGetFcnCallBlock Given an S-Function block and call index, returns the block record

for the downstream function call subsystem block.
LibGetCallerClockTickCounter Provides access to the time counter of an upstream asynchronous

task.
LibGetCallerClockTickCounter‐
HighWord

Provides access to the high word of the time counter of an upstream
asynchronous task.

LibManageAsyncCounter Determines whether an asynchronous task needs a counter and
manages its own timer.

LibNeedAsyncCounter If the calling block requires an asynchronous counter, returns
TLC_TRUE, otherwise returns TLC_FALSE.

LibSetAsyncClockTicks Returns code that sets clockTick counters that are to be
maintained by the asynchronous task.

LibSetAsyncCounter Generates code to set the tick value of the block's asynchronous
counter.

LibSetAsyncCounterHighWord Generates code to set the tick value of the high word of the block's
asynchronous counter

See Also

More About
• “Asynchronous Events”
• “Generate Interrupt Service Routines”
• “Spawn and Synchronize Execution of RTOS Task”
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model”
• “Timers in Asynchronous Tasks”
• “Import Asynchronous Event Data for Simulation”
• “Rate Transitions and Asynchronous Blocks”
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• “Asynchronous Support Limitations”
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Import Asynchronous Event Data for Simulation

Capabilities
You can import asynchronous event data into a function-call subsystem via an Inport block. For
standalone fixed-step simulations, you can specify:

• The time points at which each asynchronous event occurs
• The number of asynchronous events at each time point

Input Data Format
You can enter your asynchronous data at the MATLAB command line or on the Data Import/Export
pane of the Configuration Parameters dialog box. In either case, a number of restrictions apply to the
data format.

• The expression for parameter model configuration parameter Input must be a comma-separated
list of tables.

• The table corresponding to the input port outputting asynchronous events must be a column
vector containing time values for the asynchronous events.

• The time vector of the asynchronous events must be of double data type and monotonically
increasing.

• Time data must be integer multiples of the model step size.
• To specify multiple function calls at a given time step, you must repeat the time value

accordingly. In other words, if you wish to specify three asynchronous events at t = 1 and two
events at t = 9, then you must list 1 three times and 9 twice in your time vector. (t = [1 1 1
9 9]')

• The table corresponding to normal data input port can be of another supported format.

See “Load Data to Root-Level Input Ports” for more information.

Example
In this model, a function-call subsystem is used to track the total number of asynchronous events and
to multiply a set of inputs by 2.
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1 To input data by using the Model Configuration Parameters dialog box,

a Select Input.
b For this example, enter the following command in the MATLAB window:

>> t = [1 1 5 9 9 9]', tu = [[0:10]' [0:10]']

Alternatively, you can enter the data as t, tu in the Data Import/Export pane:

Here, t is a column vector containing the times of asynchronous events for Inport block In1
while tu is a table of input values versus time for Inport block In2.
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2 By default, the Time and Output parameters are selected and the output variables are named
tout and yout.

3 Simulate the model.
4 Display the output by entering [tout yout] at the MATLAB command line and obtain:

ans =

     0     0    -1
     1     2     2
     2     2     2
     3     2     2
     4     2     2
     5     3    10
     6     3    10
     7     3    10
     8     3    10
     9     6    18
    10     6    18

Here the first column contains the simulation times.

The second column represents the output of Out1 — the total number of asynchronous events.
Since the function-call subsystem is triggered twice at t = 1, the output is 2. It is not called again
until t = 5, and so does not increase to 3 until then. Finally, it is called three times at 9, so it
increases to 6.

The third column contains the output of Out2 obtained by multiplying the input value at each
asynchronous event time by 2. At any other time, the output is held at its previous value

See Also

More About
• “Asynchronous Events”
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model”
• “Load Data to Root-Level Input Ports”
• “Rate Transitions and Asynchronous Blocks”
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Asynchronous Support Limitations
In this section...
“Asynchronous Task Priority” on page 29-51
“Convert an Asynchronous Subsystem into a Model Reference” on page 29-51

Asynchronous Task Priority
The Simulink product does not simulate asynchronous task behavior. Although you can specify a task
priority for an asynchronous task represented in a model with the Task Sync block, the priority
setting is for code generation purposes only and is not honored during simulation.

Convert an Asynchronous Subsystem into a Model Reference
You can use the Asynchronous Task Specification block to specify an asynchronous function-call input
to a model reference. However, you must convert the Async Interrupt and Function-Call blocks into a
subsystem and then convert the subsystem into a model reference.

Following is an example with step-by-step instructions for conversion.

1 Convert the Async Interrupt and Count blocks into a subsystem. Select both blocks and right-
click Count. From the menu, select Subsystem & Model Reference > Create Subsystem
from Selection.
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2 To prepare for converting the new subsystem to a Model block, set the following configuration
parameters in the top model. Open the Configuration Parameters dialog box.

• Under Diagnostics, navigate to the Sample Time pane. Then set model configuration
parameter Multitask rate transition to error and Multitask conditionally executed
subsystem to error.

• Under Diagnostics, navigate to the Connectivity pane. Set parameter Bus signal treated
as vector to error. Also set Context-dependent inputs to Enable All.

• Under Diagnostics, navigate to the Data Validity pane and set parameter Multitask data
store to error.

• Set model configuration parameter Underspecified initialization detection to
Simplified.

• If your model is large or complex, run the Model Advisor checks in the folder “Migrating to
Simplified Initialization Mode Overview” and make the suggested changes.

3 Convert the subsystem to an atomic subsystem. Select the subsystem block parameter Treat as
atomic unit.
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4 Convert the subsystem to a Model block. Right-click the subsystem and select Subsystem &
Model Reference > Convert Subsystem to > Referenced Model. A window opens with a
model reference block inside of it.

5 Replace the subsystem in the top model with the new model reference block.

6 Move the Async Interrupt block from the model reference to the top model, before the model
reference block.

7 Insert an Asynchronous Task Specification block in the model reference. Set the priority of the
Asynchronous Task Specification block. (For more information on setting the priority, see
Asynchronous Task Specification.)

8 In the model reference, double-click the input port to open its Source Block Parameters dialog
box. In the Signal Attributes tab, select the Output function call parameter. Click OK.
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9 Save your model and then update the diagram to verify your settings.

See Also

More About
• “Asynchronous Events”
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Scheduling Considerations in Embedded
Coder

• “Use Discrete and Continuous Time” on page 30-2
• “Optimize Multirate Multitasking Execution for RTOS Run-Time Environments” on page 30-4
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Use Discrete and Continuous Time

In this section...
“Support for Discrete and Continuous Time Blocks” on page 30-2
“Support for Continuous Solvers” on page 30-2
“Support for Stop Time” on page 30-2

Support for Discrete and Continuous Time Blocks
The ERT system target file supports code generation for discrete and continuous time blocks. If you
select model configuration parameter Support: continuous time, you can use these blocks in your
models, without restriction.

Note that use of certain blocks is not recommended for production code generation for embedded
systems. The Simulink Block Data Type Support table summarizes characteristics of blocks in the
Simulink and Fixed-Point Designer block libraries, including whether or not they are recommended
for use in production code generation. To view this table, execute the following command and see the
“Code Generation Support” column of the table that appears:

showblockdatatypetable

Support for Continuous Solvers
The ERT target supports continuous solvers. In the Solver options dialog, you can select an available
solver in the Solver menu. (Note that the solver Type must be fixed-step for use with the ERT
target.)

Note Custom targets must be modified to support continuous time. The required modifications are
described in “Customize System Target Files”.

Support for Stop Time
The ERT target supports the stop time for a model. When generating host-based executables, the stop
time value is honored if one of these model configuration parameters is selected:

• External mode
• MAT-file logging
• Classic call interface

Otherwise, the executable runs indefinitely.

The ERT system target file provides generated and static examples of the ert_main.c file. The
ert_main.c file controls the overall model code execution by calling the model_step function and
optionally checking the ErrorStatus/StopRequested flags to terminate execution. For a custom
target, if you provide your own custom static main.c, consider including support for checking these
flags.
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See Also

More About
• “Time-Based Scheduling and Code Generation” on page 28-2
• “Configure Time-Based Scheduling” on page 28-33
• “Sample Times in Subsystems”
• “Sample Times in Systems”
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Optimize Multirate Multitasking Execution for RTOS Run-Time
Environments

Using the rtmStepTask macro, run-time environments that employ task management mechanisms of
an real-time operating system (RTOS)—for example, VxWorks—can improve performance of
generated code by eliminating redundant scheduling calls during the execution of tasks in a
multirate, multitasking model, The following sections describe implementation details.

Use rtmStepTask
The rtmStepTask macro is defined in model.h and its syntax is as follows:
boolean task_ready = rtmStepTask(rtm, idx);

The arguments are:

• rtm: pointer to the real-time model structure (rtM)
• idx: task identifier (tid) of the task whose scheduling counter is to be tested

rtmStepTask returns TRUE if the task's scheduling counter equals zero, indicating that the task
should be scheduled for execution on the current time step. Otherwise, it returns FALSE.

If your system target file supports model configuration parameter Generate an example main
program, you can generate calls to rtmStepTask by using the TLC function
RTMTaskRunsThisBaseStep.

Schedule Code for Real-time Model without an RTOS
To understand the optimization that is available for an RTOS target, consider how the ERT target
schedules tasks for bareboard targets (where RTOS is not present). The ERT target maintains
scheduling counters and event flags for each subrate task. The scheduling counters are implemented
within the real-time model (rtM) data structure as arrays, indexed on task identifier (tid).

The scheduling counters are updated by the base-rate task. The counters are clock rate dividers that
count up the sample period associated with each subrate task. When a given subrate counter reaches
a value that indicates it has a hit, the sample period for that rate has elapsed and the counter is reset
to zero. When this occurs, the subrate task must be scheduled for execution.

The event flags indicate whether or not a given task is scheduled for execution. For a multirate,
multitasking model, the event flags are maintained by code in the main program for the model. For
each task, the code maintains a task counter. When the counter reaches 0, indicating that the task's
sample period has elapsed, the event flag for that task is set.

On each time step, the counters and event flags are updated and the base-rate task executes. Then,
the scheduling flags are checked in tid order, and tasks whose event flag is set is executed.
Therefore, tasks are executed in order of priority.

For bareboard targets that cannot rely on an external RTOS, the event flags are mandatory to allow
overlapping task preemption. However, an RTOS target uses the operating system itself to manage
overlapping task preemption, making the maintenance of the event flags redundant.
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Schedule Code for Multirate Multitasking on an RTOS
The following task scheduling code, from ertmainlib.tlc, is designed for multirate multitasking
operation on an example RTOS (VxWorks) target. The example uses the TLC function
RTMTaskRunsThisBaseStep to generate calls to the rtmStepTask macro. A loop iterates over each
subrate task, and rtmStepTask is called for each task. If rtmStepTask returns TRUE, the RTOS
semGive function is called, and the RTOS schedules the task to run.
%assign ifarg = RTMTaskRunsThisBaseStep("i")
for (i = 1; i < %<FcnNumST>; i++) {
   if (%<ifarg>) {
     semGive(taskSemList[i]);
     if (semTake(taskSemList[i],NO_WAIT) != ERROR) {
       logMsg("Rate for SubRate task %d is too fast.\n",i,0,0,0,0,0);
       semGive(taskSemList[i]);
     }
   }
}

Suppress Redundant Scheduling Calls
Redundant scheduling calls are still generated by default for backward compatibility. To change this
setting and suppress them, add the following TLC variable definition to your system target file before
the %include "codegenentry.tlc" statement:
%assign SuppressSetEventsForThisBaseRateFcn = 1

See Also

More About
• “Time-Based Scheduling and Code Generation” on page 28-2
• “Modeling for Multitasking Execution” on page 28-9
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Representing a Software Architecture
by Creating Code Generation Definitions

• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”
on page 31-2

• “Create Code Definitions Programmatically” on page 31-5
• “Deploy Code Generation Definitions” on page 31-10
• “Generate Code to Conform to Software Architecture by Sharing and Copying Default Settings

Between Models” on page 31-18
• “Manage an Embedded Coder Dictionary” on page 31-21
• “Migration of Memory Section and Shared Utility Settings from Configuration Parameters to Code

Mappings” on page 31-25
• “Flexible Storage Class for Different Model Hierarchy Contexts” on page 31-28
• “Separation of Code Definitions from Model-Specific Data and Function Configurations”

on page 31-31
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Define Storage Classes, Memory Sections, and Function
Templates for Software Architecture

In a team or large organization, to enable multiple users to generate code that conforms to a
standard architecture, you can create and share code generation definitions, such as storage classes,
with those users. When configuring code generation settings for different models, the users can apply
the definitions to data and function elements in the models, generating standardized code.

Create Code Definitions for Use in the Code Mappings Editor
To control the appearance of model elements in the generated code, you apply code definitions to the
elements by using the Code Mappings editor. Configure the default code generation behavior for a
category of model elements by selecting a code definition in the default mapping for the category.
Configure individual data elements by mapping them to code definitions in the Code Mappings editor.

To create code definitions that you and other users can use in the Code Mappings editor, use an
Embedded Coder Dictionary.

When you create definitions in an Embedded Coder Dictionary, decide where to store the definitions
by considering how you intend to use them. This table lists where to store the code definitions and
how to use Simulink data dictionaries.

Usage of Definitions Location for Code Definitions Data Dictionary Use
Multiple models — sharing a set
of code definitions to
standardize code

Simulink data dictionary that is
referenced by all of the models,
either directly or through
intermediate referenced
dictionaries

Link each model to a data
dictionary that defines the code
definitions, either directly or
through an intermediate
dictionary reference.

One model — prototyping
generated code by using one
model

Local Embedded Coder
Dictionary of the model

You can optionally link the
model to a data dictionary that
contains other data. If you link
the model to a dictionary that
contains other code definitions,
the model can also use those
code definitions.

To use an Embedded Coder Dictionary and for its limitations with respect to code generation
definitions, see Embedded Coder Dictionary.

Create Code Definitions for External Data Objects
To create definitions for data objects that you store in the base workspace or in a Simulink data
dictionary, use the Custom Storage Class designer to create a definition in a package. For these data
objects, you apply code generation settings to the data object instead of applying them in the
mapping of a model. When an item in a model uses the data object and its code generation settings,
the code mapping for the item reflects the specification of the data object. For more information, see
“Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15 and “Control
Data and Function Placement in Memory by Inserting Pragmas” on page 43-2.
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Use Package Code Definitions in Embedded Coder Dictionaries
If you want to use the same code generation definition in the Code Mappings editor and in data
objects, you do not need to store one copy of the definition in an Embedded Coder Dictionary and
another copy in a package. Instead, store the definition in a package (by using the Custom Storage
Class Designer). Then, configure one or more Embedded Coder Dictionaries to refer to the definition
in the package. With this technique, when you want to make changes to the definition, you make the
changes in only one place, the package.

To create a code generation definition in a package by using the Custom Storage Class Designer, see
“Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15. Then, to
configure an Embedded Coder Dictionary to refer to the package, see “Refer to Code Generation
Definitions in a Package”.

For more information about maintaining definitions in packages and dictionaries, see “Migrate
Package Definitions to Embedded Coder Dictionary to Use in Code Mappings” on page 31-21.

Constrain Use of Storage Class Code Mappings
When defining a storage class in the Embedded Coder Dictionary, you can specify whether users can
map the storage class to parameters, signals, or parameters and signals. To constrain the use of a
storage class, the Data Initialization property must be set to Auto or None. Then, in the Property
Inspector, under Allowed Usage, select Parameters, Signals, or Parameters and Signals. For
more information, see Embedded Coder Dictionary.

Deploy Code Generation Definitions to Users
In a large organization with multiple models and users, you can share code generation definitions by
storing them in a mutually accessible location. The process of sharing code definitions is called
deployment. For more information, see “Deploy Code Generation Definitions” on page 31-10.

Interact with Code Generation Definitions Programmatically
You can create and interact with code definitions by using the Embedded Coder Dictionary API.

1 Represent the Embedded Coder Dictionary by using a coder.Dictionary object. Use the
object to access the sections of the dictionary: Storage Classes, Memory Sections, and Function
Customization Templates. If you have a package of code definitions, use the coder.Dictionary
object to load and refresh the package in the dictionary.

2 Represent a section of the dictionary by using a coder.dictionary.Section object. Use the
section to access code definitions.

3 Represent a code definition by using a coder.dictionary.Entry object. Use the entry to
interact with the code definition and its properties.

You can also use functions such as coder.dictionary.copy and coder.dictionary.move to
perform operations on Embedded Coder Dictionaries. For more information, see “Create Code
Definitions Programmatically” on page 31-5.

See Also
Embedded Coder Dictionary | Code Mappings editor
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Related Examples
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15
• “Generate Code to Conform to Software Architecture by Sharing and Copying Default Settings

Between Models” on page 31-18
• “Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Create Code Definitions Programmatically
This example shows how to programmatically create code definitions in an Embedded Coder
Dictionary. To automate the creation of an Embedded Coder Dictionary in a script or to create
definitions programmatically, use this programming interface.

In this example, you create an Embedded Coder Dictionary in a Simulink data dictionary so that
multiple models can share the code definitions. You create code definitions that control the naming
and placement of global data and functions. You also use a memory section definition that includes a
pragma to place the data and functions in fast memory. To verify the architecture that you set up
through the code definitions, apply the definitions to a model, and then generate code.

Set Up Embedded Coder Dictionary

Create a Simulink data dictionary to store the code definitions. Storing the definitions in a data
dictionary enables you to use the definitions in multiple models by linking each model to the data
dictionary as shown in Apply Code Generation Definitions on page 31-0 .

dataDictionary = Simulink.data.dictionary.create('dataDictionary.sldd');

Create an Embedded Coder Dictionary in the data dictionary. When you create the dictionary,
represent it with a coder.Dictionary object. Use the object to perform operations on the entire
Embedded Coder Dictionary and to access sections of it.

codeDictionary = coder.dictionary.create('dataDictionary.sldd');

The coder.Dictionary object contains three coder.dictionary.Section objects that represent
the sections of an Embedded Coder Dictionary: Storage Classes, Memory Sections, and Function
Customization Templates. A coder.dictionary.Section object contains
coder.dictionary.Entry objects that represent the definitions in that section. To interact with a
definition and access its properties, use the coder.dictionary.Entry object that represents it.
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When you create an Embedded Coder Dictionary, the dictionary loads definitions from the Simulink
package so that the Embedded Coder Dictionary then contains built-in definitions. If you have custom
code definitions stored in a package, load that package to the dictionary. When you use the
Embedded Coder Dictionary to configure the code interface for a model, you can apply definitions
from packages that you loaded.

Memory Sections

To create memory section definitions, add entries to the Memory Sections section. Storage classes
and function customization templates residing in the same dictionary can use these memory sections.
For this example, add a memory section named FastMem, which allocates memory by using a pragma.
When you apply the memory section to a storage class or function template, their generated
definitions and declarations are in the memory section.

memorySections = getSection(codeDictionary,'MemorySections');
msFast = addEntry(memorySections,'FastMem');
set(msFast,'PreStatement','#pragma begin FAST');
set(msFast,'Comment','/*Fast onchip RAM*/');
set(msFast,'PostStatement','#pragma end FAST');

Storage Classes

For this example, create a storage class named ExportToPrivateHeader, which generates a global
variable declaration in the header file $R_private.h and definition in $R_private.c. The token $R
signifies the name of the root model for which you generate code. To use a variable in external code,
apply this storage class to the data element and include the header file in the external code.

storageClasses = getSection(codeDictionary,'StorageClasses');
exportToPrivateH = addEntry(storageClasses,'ExportToPrivateHeader');
set(exportToPrivateH,'HeaderFile','$R_private.h','DataScope','Exported');

To apply the memory section FastMem to the storage class, use the coder.dictionary.Entry
object that represents the memory section.

set(exportToPrivateH,'MemorySection',msFast);

Create another storage class definition named ImportFromHeader for data that external code
defines. Because the storage class has 'DataScope' set to 'Imported', the generated code reads
and writes to the variable defined by your external code.

importFromH = addEntry(storageClasses,'ImportFromHeader');
set(importFromH,'DataScope','Imported','HeaderFile','$R_input.h','DataInit','Dynamic');

Function Customization Templates

To create a function customization template, create another coder.dictionary.Section object
that represents the Function Customization Templates section. Add an entry to this section, which
represents a definition that controls the appearance of generated entry-point functions. Apply the
memory section FastMem to the function template.

functionTemplates = getSection(codeDictionary,'FunctionCustomizationTemplates');
fcGlobal = addEntry(functionTemplates,'GlobalFunctions');
set(fcGlobal,'FunctionName','$R$N');
set(fcGlobal,'MemorySection',msFast);
saveChanges(dataDictionary);
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Apply Code Generation Definitions

Confirm the settings of your code definitions by applying them to a model and generating code. You
can configure the model code interface to use the code definitions programmatically or by using the
Code Mappings editor.

Open the model rtwdemo_configinterface and link the model to the data dictionary that you
created.

rtwdemo_configinterface
set_param('rtwdemo_configinterface','DataDictionary','dataDictionary.sldd');

The model contains four inports. In1 is configured to use the storage class ImportFromFile. For
this example, you configure the other inports to read data from external code by default. The model
also contains state data for the Delay block that you configure to be accessible by external code.
When you apply the storage classes ImportFromHeader and ExportToPrivateHeader to the
model elements, the generated code conforms to this architecture.

To configure the model with the code generation definitions, get the code mapping for the model.

cm = coder.mapping.api.get('rtwdemo_configinterface');

Use the code mapping to configure data to use your storage class definitions. For the state data in the
Delay block, specify the storage class ExportToPrivateHeader.

setState(cm,'rtwdemo_configinterface/Delay','StorageClass','ExportToPrivateHeader');

Specify the default storage class ImportFromHeader for root inport data. For inports of the model,
by default, the generated code uses data that external code defines in the file
rtwdemo_configinterface_input.c. To compile and link this external file when you build the
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generated code, set the configuration parameter CustomSource to
rtwdemo_configinterface_input.c.

setDataDefault(cm,'Inports','StorageClass','ImportFromHeader');
set_param('rtwdemo_configinterface','CustomSource','rtwdemo_configinterface_input.c');

Specify the function customization template GlobalFunctions for the default code generation of
execution functions.

setFunctionDefault(cm,'Execution','FunctionCustomizationTemplate','GlobalFunctions');

Verify that the code definitions reflect your specifications.

1 Open the Code Mappings editor. In the Simulink Editor, open the Embedded Coder app. On the C
Code tab, select Code Interface > Default Code Mappings.

2 In the Code Mappings editor, on the Data Defaults tab, expand the Inports and Outports
section. The Inports category shows the storage class ImportFromHeader. On the Inports tab,
the inports In2, In3, and In4 use the model default storage class ImportFromHeader. The
inport In1 has a different storage class specified, ImportFromFile. This setting overrides the
default storage class so that In1 reads data from a different external file.

3 On the Signals/States tab, the state X shows the storage class ExportToPrivateHeader.
4 On the Function Defaults tab, the Execution category shows the template GlobalFunctions.
5 Open the Embedded Coder Dictionary. On the C Code tab, select Code Interface > Embedded

Coder Dictionary. The code definitions that you added to the dictionary appear in the tabs.

Generate and Verify the Code

Generate code for the model.

slbuild('rtwdemo_configinterface', 'generateCodeOnly', true);

### Starting build procedure for: rtwdemo_configinterface
### Successful completion of code generation for: rtwdemo_configinterface

Build Summary

Top model targets built:

Model                    Action          Rebuild Reason                                    
===========================================================================================
rtwdemo_configinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 50.875s

The header file rtwdemo_configinterface_private.h defines the Delay block state data
according to the storage class ExportToPrivateHeader. External code can access this state data.

file = fullfile('rtwdemo_configinterface_ert_rtw','rtwdemo_configinterface_private.h');
rtwdemodbtype(file,'/* Storage class', ...
   '#endif');

/* Storage class 'ExportToPrivateHeader' */

/*Fast onchip RAM*/
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#pragma begin FAST

extern MYTYPE X;                       /* '<Root>/Delay' */

#pragma end FAST

Because the inports use the storage class specifications, the generated header files do not define
inport data. Instead, the generated file rtwdemo_configinterface.h includes the external header
file that you specified in the storage class definition. The generated code reads inport data from the
variables defined in the external file rtwdemo_configinterface_inputs.c.

In the generated source file rtwdemo_configinterface.c, the execution (step) function reflects
the settings of the function customization template GlobalFunctions. Because the template
GlobalFunctions uses the memory section FastMem, the execution function is stored in the
memory section and reflects the prestatement, poststatement, and comments that you set in the
FastMem definition.

file2 = fullfile('rtwdemo_configinterface_ert_rtw','rtwdemo_configinterface.c');
rtwdemodbtype(file2,'/* Model step function */', ...
   '/* Logic:');

/* Model step function */

/*Fast onchip RAM*/
#pragma begin FAST

void rtwdemo_configinterface_step(void)
{

After you configure the Embedded Coder Dictionary, you can share the dictionary with your team or
organization. You and other users can apply your definitions to multiple models so that the models
use the same software architecture.

See Also
Embedded Coder Dictionary | Code Mappings editor | coder.Dictionary |
coder.dictionary.Entry | coder.dictionary.Section |
coder.mapping.api.CodeMapping

Related Examples
• “Deploy Code Generation Definitions” on page 31-10
• “Generate Code to Conform to Software Architecture by Sharing and Copying Default Settings

Between Models” on page 31-18
• “Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Deploy Code Generation Definitions
As described in “Define Storage Classes, Memory Sections, and Function Templates for Software
Architecture” on page 31-2, you can create code generation definitions that you and other users can
apply to model elements such as data and functions. The code definitions control the appearance of
those elements in the generated code.

In a large organization with multiple models and users, you can share code generation definitions by
storing them in a mutually accessible location. The process of sharing code definitions is called
deployment.

Share Code Generation Definitions Between Multiple Models and
Users
When you create custom code generation definitions, to share the definitions between models and
other users:

• When you create definitions in a package by using the Custom Storage Class Designer, for each
user, place the folder containing the package folder on the MATLAB path. For more information,
see “What Is the MATLAB Search Path?”.

• When you create definitions in an Embedded Coder Dictionary, store the definitions in a Simulink
data dictionary. Then, link each model to a separate data dictionary. Configure each separate
dictionary to refer to the dictionary that contains the code generation definitions. For an example,
see “Share Embedded Coder Dictionary Definition Between Models” on page 31-12.

Dictionary Usage for Models Created with Different Versions of
Simulink
Simulink provides version handling for Embedded Coder Dictionaries. When these events occur,
Simulink synchronizes data in a data dictionary, including the Embedded Coder Dictionaries, for use
with a model regardless of the Simulink version used to create the model.

• You link a model to a data dictionary that was saved in a previous version of Simulink (for
example, you link a model that you develop in R2018b with a dictionary saved in R2018a).

• You open a model, which has a local Embedded Coder Dictionary, in a version of Simulink that is
older than the current version (for example, you developed a model that uses a local dictionary in
R2018a and you open that model in R2018b to continue development).

You also have the option to export (save) an Embedded Coder Dictionary for use with models created
with a different version (previous or older) of the code generator.

For more information, see “Dictionary Usage for Models Created with Different Versions of Simulink”.

Configure Default Code Mapping in a Shared Dictionary
While setting up an Embedded Coder Dictionary intended to be shared by multiple models, you can
map default code definitions for categories of model data and functions. In this example, you map
default code definitions for the Embedded Coder Dictionary in exSharedCodeDefs.sldd.
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1 If not already defined, define code definitions (storage classes, function customization templates,
and memory sections) in a data dictionary. For this example, you define code definitions in data
dictionary exSharedCodeDefs.sldd. Place a copy of this file in a writeable location.

2 In Current Folder pane of the MATLAB Command Window, double-click the file name of your
copy of exSharedCodeDefs.sldd.

3 In the Model Hierarchy pane of the Model Explorer, right-click the dictionary node and select
Show Empty Sections. Model Explorer lists nodes for Design Data, Configurations,
Embedded Coder Dictionary, and Other data.

4 Open the Embedded Coder Dictionary. In the Model Hierarchy pane, click Embedded Coder
Dictionary. Then, in the right pane, click Open Embedded Coder Dictionary.

5 In the Embedded Coder Dictionary dialog box, click Configure Defaults.
6 In the Configure Dictionary Defaults dialog box, configure default code definitions for categories

of data and functions.

• On the Data Defaults tab, configure the storage class and, if applicable, a memory section,
for these categories of data:

Model Element Category Description
Inports Root-level input ports of a model, such as Inport and In

Bus Element blocks.
Outports Root-level output ports of a model, such as Outport and

Out Bus Element blocks.
Signals, states, and internal
data

Data elements that are internal to the model, such as
block output signals, discrete block states, data stores,
and zero-crossing signals.

Shared local data stores Data Store Memory blocks that have the block
parameter Share across model instances set. These
data stores are accessible only in the model where they
are defined. The data store value is shared across
instances of the model.

Global data stores Data stores that are defined by a signal object in the
base workspace or in a data dictionary. Multiple models
in an application can use these data stores. To view and
configure these data stores in the Code Mappings
editor, click the Refresh link to the right of the
category name. Clicking this link updates the model
diagram.

Model parameter
arguments

Parameters in the model workspace that you configure
as model arguments. These parameters are exposed at
the model block to enable each model instance to
provide its own value. To specify a parameter as a
model argument, select the Model Data Editor >
Parameters > Argument check box.

Model parameters Parameters that are defined within a model, such as
parameters in the model workspace. Excludes model
arguments.
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Model Element Category Description
External parameters Parameters that you define as objects in the base

workspace or in a data dictionary. Multiple models in an
application can use these parameters. To view and
configure these parameters in the Code Mappings
editor, click the Refresh link to the right of the
category name. Clicking this link updates the model
diagram.

Constants Constant-value block output and parameters that could
not be inlined. These values are stored in variables for
one of the following reasons.

• The value is an array larger than the loop unrolling
threshold.

• The value address is needed in the code.
• On the Function Defaults tab, configure the function customization template and, if

applicable, a memory section, for these categories of functions:

Model Function Category Description
Initialize/Terminate Entry-point functions for initialization and termination
Execution Entry-point functions for initiating execution and resets
Shared utility Shared utility functions

The default mapping for a category applies to elements in a category throughout a model.

For this example, set the storage class for data categories Inports, Outports, and Global data
stores to ExportedGlobal.

7 Apply your changes and close the dialog box. Click Apply. Then, click OK.
8 Close the Embedded Coder Dictionary and Model Explorer.

Share Embedded Coder Dictionary Definition Between Models
This example shows how to create a storage class that yields separate global variables in the
generated code and share the storage class between two models, rtwdemo_roll and
rtwdemo_configinterface. Then, you configure each model to use the storage class as the default
code generation setting for internal data, which includes block states.

It is a best practice to store shared code generation definitions in a standalone data dictionary, which
means that no models are linked directly to the dictionary. Then, you can link the target models to
one or more additional, intermediate dictionaries, which you configure to refer to the standalone
dictionary. With this modular dictionary hierarchy, each model can store other data, such as design
data, separately from the code generation definitions.

In a hierarchy of referenced data dictionaries (see “Dictionary Referencing”), only one dictionary can
store code generation definitions in an Embedded Coder Dictionary. If a model has access to multiple
Embedded Coder Dictionaries through referenced data dictionaries, use the functions
coder.dictionary.move and coder.dictionary.remove to transfer and delete Embedded
Coder Dictionaries until only one exists in the dictionary hierarchy.

The figure shows an example dictionary hierarchy. In the figure:
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• modelOne.slx and modelTwo.slx are different model files.
• dataForModelOne.sldd and dataForModelTwo.sldd are data dictionaries. Each dictionary

stores design data, such as numeric MATLAB variables, for one of the models.
• coderDefs.sldd is a shared data dictionary that stores code generation definitions for both

models. The other dictionaries reference coderDefs.sldd.

Create Code Generation Definition in Standalone Data Dictionary

Create a data dictionary. Then, create the storage class in the dictionary.

1 At the command prompt, open the Model Explorer.

daexplr
2 In the Model Explorer, select File > New > Data Dictionary.
3 Name the dictionary coderDefs.sldd.
4 In the Model Explorer Model Hierarchy pane, right-click coderDefs and select Show Empty

Sections.
5 Select the Embedded Coder Dictionary node.
6 In the Dialog pane (the right pane), click Open Embedded Coder Dictionary.
7 In the Embedded Coder Dictionary dialog box, click Add.
8 For the new storage class, in the Property Inspector pane, set Name to internalsInFile.
9 In the Model Explorer Model Hierarchy pane, right-click coderDefs and select Save Changes.

Link Models to Data Dictionaries

Link each model to a separate data dictionary. Configure each dictionary to refer to the standalone
dictionary (coderDefs.sldd).

1 Open the models.

rtwdemo_configinterface
rtwdemo_roll
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2 In rtwdemo_roll, on the Modeling tab, in the Design gallery, click Link to Data Dictionary.
3 In the Model Properties dialog box, click New.
4 Create a dictionary named rtwdemo_roll_data.sldd by using the Create a new Data

Dictionary dialog box.
5 In the Model Properties dialog box, click OK.

Simulink links the model to the new dictionary. The dictionary does not contain any data because
the model does not use data in the base workspace.

6 Open the dictionary in the Model Explorer. In the lower-left corner of the model, click the model
data badge, then click the External Data link. Under the External Data node, select
rtwdemo_roll_data.sldd.

7 In the Dialog pane, under Referenced Dictionaries, click Add.
8 In the Open Data Dictionary dialog box, double-click coderDefs.sldd.
9 Use the Model Hierarchy pane to save the changes you made to rtwdemo_roll_data.sldd.
10 Link rtwdemo_configinterface to a dictionary named

rtwdemo_configinterface_data.sldd.

rtwdemo_configinterface uses a variable in the base workspace. To migrate the variable into
the dictionary, in the Model Properties dialog box, click Migrate data. Then follow the
instructions to link the model to the dictionary and copy the referenced variables.

11 Configure rtwdemo_configinterface_data.sldd to refer to coderDefs.sldd.

Apply Code Generation Definition in Models

Confirm that the shared definition is available for use in the models by applying it as a default setting
for internal data and inspecting the generated code.

1 In rtwdemo_roll, click the C Code tab. If the toolstrip does not show the C Code tab, open the
Embedded Coder app.

2 Under Code Mappings > Data Defaults, for the Signals, states, and internal data row, set
Storage Class to internalsInFile.

3 In rtwdemo_configinterface, use the Code Mappings editor to set Storage Class to
internalsInFile for the Signals, states, and internal data row.

4 Generate code from rtwdemo_roll.
5 In the Code view, inspect the generated file rtwdemo_roll.c. The file defines global variables

that correspond to state data in the model, such as the state of the Integrator block in the
BasicRollMode subsystem.

/* Storage class 'internalsInFile' */
real32_T rtwdemo__FixPtUnitDelay1_DSTATE;
real32_T rtwdemo_roll_Integrator_DSTATE;
int8_T rtwde_Integrator_PrevResetState;

6 Optionally, generate code from rtwdemo_configinterface and confirm that the code appears
as expected.

Migrate Definitions from Model File to Shared Data Dictionary
If you create code generation definitions in the Embedded Coder Dictionary of a model, the
definitions are stored in the model file. If you want to share the definitions between models:

1 Create a shared data dictionary as shown in “Share Embedded Coder Dictionary Definition
Between Models” on page 31-12. Before you proceed to the next step, make sure all of the target
models have access to the shared dictionary.
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2 Use the coder.dictionary.move function to migrate the definitions from the source model file
to the shared data dictionary.

To migrate individual definitions, in the Embedded Coder Dictionary dialog box, use the Cut and
Paste buttons on the quick access toolbar.

3 Optionally, copy Code Mappings editor settings from the source model to other models by using
the programmatic interface of the Code Mappings editor (see “Configure Default Data and
Function Code Generation Programmatically” on page 33-24).

In this example, you convert a subsystem to a referenced model. Then, you create a storage class in
the Embedded Coder Dictionary of the top model and use the storage class in the Code Mappings
editor. To use the same Code Mappings editor settings for the top model and for the referenced
model, you must extract the storage class into a shared data dictionary (.sldd).

Create Referenced Model

1 Open the example model rtwdemo_roll.

rtwdemo_roll
2 In the model, right-click the BasicRollMode subsystem and select Subsystem & Model

Reference > Convert to > Referenced Model.
3 Click Convert.

The new referenced model, BasicRollMode, opens. The model file is in your current folder.

Create and Apply Storage Class

1 In the top model rtwdemo_roll, click the C Code tab. If the toolstrip does not show the C Code
tab, open the Embedded Coder app.

2 Click Code Interface > Embedded Coder Dictionary.
3 In the Embedded Coder Dictionary dialog box, on the Storage Classes tab, click Add.
4 For the new storage class, set these property values:

• Name to internalsInFile.
• Header File to $R_internal.h.
• Definition File to $R_internal.c.

5 In the model, in the Code Mappings editor, for the Data Defaults > Signals, states, and
internal data row, set Storage Class to internalsInFile.

The referenced model cannot access the code generation definitions in the Embedded Coder
Dictionary of the parent model. Now, move the storage class out of the parent model and into a
shared data dictionary.

Move Storage Class to Shared Data Dictionary

As a best practice, link each model to a separate data dictionary (.sldd), create a shared, standalone
data dictionary to store the code generation definition (the storage class), and configure dictionary
referencing so that all of the models can use the code generation definition.

To link the models to separate dictionaries:

1 In rtwdemo_roll, on the Modeling tab, in the Design gallery, click Link to Data Dictionary.
2 In the Model Properties dialog box, click New.
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3 Use the Create a new Data Dictionary dialog box to create a dictionary named
rtwdemo_roll_data.sldd.

4 In the Model Properties dialog box, click OK.
5 In the Link Model to Data Dictionary dialog box, click Change this model only.
6 In the BasicRollMode model, use the Model Properties dialog box to link the model to a new

data dictionary named basicRollMode_data.sldd.
7 Click, OK.

To create the shared, standalone dictionary and store the code generation definition in it:

1 In both models, open the dictionary in the Model Explorer. At the lower-left corner of the block
diagram, click the model data badge, then click the External Data link. Under the External
Data node, select the dictionary.

2 In the Model Explorer, select File > New > Data Dictionary.
3 Create a data dictionary named coderDefs.sldd.
4 In the Model Explorer Model Hierarchy pane, select the rtwdemo_roll_data node.
5 In the Dialog pane (the right pane), under Referenced Dictionaries, click Add.
6 Add a reference to coderDefs.sldd.
7 Configure basicRollMode_data.sldd to refer to coderDefs.sldd.
8 In the Model Hierarchy pane, right-click the rtwdemo_roll_data node and select Save

Changes.
9 At the command prompt, move the code generation definitions from the rtwdemo_roll model

file to the coderDefs.sldd data dictionary.

coder.dictionary.move('rtwdemo_roll','coderDefs.sldd');

Now, both models have access to the storage class internalsInFile.

Copy Code Mappings Editor Settings from Parent Model to Referenced Model

The new referenced model does not use the Code Mappings editor settings that the parent model
uses. To copy the settings from the parent model to the referenced model, use the programmatic
interface of the Code Mappings editor.

At the command prompt, copy the storage class setting for Signals, states, and internal data from
rtwdemo_roll to BasicRollMode.

roll_mapping = coder.mapping.api.get('rtwdemo_roll');
roll_sc = getDataDefault(roll_mapping,'InternalData','StorageClass');

mode_mapping = coder.mapping.api.get('BasicRollMode');
setDataDefault(mode_mapping,'InternalData','StorageClass',roll_sc);

Now, both models use the same Code Mappings editor settings. For more information about the
programmatic interface of the Code Mappings editor, see “Configure Default Data and Function Code
Generation Programmatically” on page 33-24.

Use Data Dictionary to Store Code Definitions but Not Design Data
A Simulink data dictionary can store design data such as MATLAB variables and
Simulink.AliasType objects (see “Global and Shared Data: Data Dictionary”). However, migrating
the design data of a large model or of multiple models from the base workspace to a data dictionary
can take time and careful planning.

If you want to store shared code generation definitions in a data dictionary but do not want to
migrate the design data of a model, in the Model Properties dialog box, on the External Data tab,
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select the Enable model access to base workspace property. The model can use design data from
the base workspace and code generation definitions from the dictionary or from a referenced
dictionary. For more information, see “Continue to Use Shared Data in the Base Workspace”.

See Also
Embedded Coder Dictionary

Related Examples
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Generate Code to Conform to Software Architecture by Sharing and Copying Default Settings

Between Models” on page 31-18
• “Partition Data for Model Reference Hierarchy Using Data Dictionaries”
• “Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15
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Generate Code to Conform to Software Architecture by Sharing
and Copying Default Settings Between Models

In a project where you generate code from many models, you can configure the models with the same
default code settings so that they generate code that conforms to your software architecture
standards. These settings include:

• Configuration parameter settings
• Code interface definitions such as storage classes
• Code mappings that specify code definitions for categories of model data and functions

As projects expand and you and your colleagues create more models, manually configuring the
default settings for each new model takes time. To reduce this manual data entry, you can use tools to
configure many models by default. You can copy settings between models, enabling each model to
later change the settings independently of each other. Alternatively, you can share settings, enabling
you to change the settings for multiple models simultaneously with minimal effort.

Share Common Code Generation Settings among Multiple Models
One way to make models conform to code generation standards is by storing the settings in one
location and sharing them among the models. Share settings that you might want to change so that
when you do change the settings, the models are updated. To share code generation settings among
multiple models, store the settings in a standalone Simulink data dictionary. Then, link each model to
one or more additional, intermediate dictionaries. Configure the intermediate dictionaries to refer to
the standalone dictionary. With this modular dictionary hierarchy, each model can store other data,
such as design data, separately from the shared settings. For an example that shows how to store
shared data in a dictionary, see “Partition Data for Model Reference Hierarchy Using Data
Dictionaries”. Once you set up the data dictionary hierarchy for your models, choose which code
generation settings that you want to share by using the dictionary.

Model Configuration Parameter Settings

Configuration parameters control model-wide settings including code generation options such as the
system target file, target language, and custom code files. A model's configuration parameters are
stored in the configuration set. For code generation parameters on the Code Generation pane and
links to the pages for the code generation sub-panes, see “Model Configuration Parameters: Code
Generation”. Some systems that include multiple models require that many of the configuration
parameter settings be consistent across the models. For example, when you generate code for a
model reference hierarchy, the models in the hierarchy must have the same settings for many of the
code generation parameters. In this type of system, share one configuration set with the models.

To share configuration settings among multiple models, store the settings in a standalone
configuration set object. Save the configuration object in a Simulink data dictionary that the models
share. For each model, activate a configuration reference that points to the shared configuration set.
For an example of how to share a configuration set among multiple models, see “Share a
Configuration with Multiple Models”. When you want to change parameter settings, edit the shared
configuration set. The models that reference it use the new settings. To quickly share a configuration
set among referenced models in a hierarchy, see “Share a Configuration Across Referenced Models”.

Code Interface Definitions

For the code interface of many models to conform to the same specifications, define the interface in a
set of shared code interface definitions in an Embedded Coder Dictionary. Use a code definition to
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specify many detailed code properties. Then you can control the code interface of your data items and
functions by applying the code definitions using the code mapping. Code interface definitions include:

• Storage classes
• Memory sections
• Function customization templates

Once you create your code interface definitions, apply them to a model by mapping model data and
functions to the definitions. Sharing one set of code definitions among multiple models enables you to
quickly apply the same set of interface specifications by mapping the data and functions in each
model to the definitions.

To share a set of code definitions among multiple models, create the definitions in the Embedded
Coder Dictionary section of the Simulink data dictionary that the models share. Then, map the data
and functions in the model to the shared definitions. For an example of how to share definitions
among multiple models, see “Share Embedded Coder Dictionary Definition Between Models” on page
31-12.

Code Mappings

Models can also share the default mapping configuration that applies the definitions to data and
function categories. In the shared Embedded Coder Dictionary, you configure the dictionary default
mapping. When you link a model to the dictionary, the model uses the dictionary mapping by default.
You can still change the default mapping and individual mapping for an individual model if the model
requires a different configuration. For more information about sharing the dictionary default mapping
among multiple models, see “Configure Default Code Mapping in a Shared Dictionary” on page 31-10.

Copy Code Generation Settings to New Models
If you do not want to share code generation settings from one source, you can use other tools to
configure models by copying the code generation settings. When you use these techniques, you can
easily change the settings for an individual model after the initial configuration. If you want to change
a setting for many models that are already configured, you must change each model individually. In
the model development process, consider when you want to apply the settings to your models and use
one of these techniques.

Template Models

If you want new models to be configured at the time they are created, use a template model. You can
create a template model that has preconfigured settings such as configuration parameter settings
and Code Mappings editor settings. To create a model, you and others can instantiate the template.
Each new model can later change their settings independently of other models. See “Create Template
from Model”.

When you create a model by instantiating a template, the new model is not linked to a data dictionary.
If the preconfigured settings in the template model depend on shared data that you store in a data
dictionary, you must configure dictionary linking and referencing for each new model.

Template Projects

If you want new models to use data that you store outside of the models, such as in a data dictionary,
use template projects. You can create a template project that contains models, data dictionaries, and
other artifacts. You can also write project shortcuts that execute custom code to create models, copy
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settings, and make shared settings stored in a dictionary available to new models. For more
information about using template projects, see “Create Templates for Standard Project Settings”.

Programmatic Configurations

If you want to copy settings to a model after you create it, you can write scripts, callbacks, and
shortcuts that use the programmatic interfaces to configure code generation settings. Configure
these code generation settings by using the corresponding programmatic interfaces:

• For configuration parameter settings, use the set_param and get_param functions. You can
write a script that sets many parameters, as described in “Automate Model Configuration by Using
a Script”.

• For code interface definitions in an Embedded Coder Dictionary, see the example “Create Code
Definitions Programmatically” on page 31-5.

• For Code Mappings editor settings, see “Configure Default Data and Function Code Generation
Programmatically” on page 33-24.

Choose how to execute the code by considering when you want to configure the models. You can
execute this code in:

• A script. You can configure the models at any time by running the script manually.
• A model callback. A callback uses your code to configure the model each time the callback is

called. For example, you can use the PreLoadFcn callback, which executes whenever you open a
model. See “Model Callbacks”.

• A project shortcut. The shortcut can create a model and copy settings into the model. See “What
Can You Do With Project Shortcuts?”.

After you use the code to configure the models, you can change the settings on each individual model
as needed.

See Also

Related Examples
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Deploy Code Generation Definitions” on page 31-10
• “Partition Data for Model Reference Hierarchy Using Data Dictionaries”

31 Representing a Software Architecture by Creating Code Generation Definitions

31-20



Manage an Embedded Coder Dictionary
After you create code definitions for standardization and software architecture conformance and
deploy them to your users, keep the definitions and their usage up to date. When you and other users
create models for code generation, make your code definitions available to the models. If the
standards for your generated code change, you might need to update your code definitions. Consider
how these standards changes impact models that use your code definitions and update the models
accordingly.

Share Available Code Definitions with New Models
If you share code definitions in a Simulink data dictionary, make the definitions available to new
models that you or your users create for code generation. A model that you create from the Simulink
Start Page or by using the new_system function is not linked to a Simulink data dictionary. The new
model cannot access code generation definitions that you store in a data dictionary.

To make code definitions available to a new model automatically, write callbacks and other code that
immediately links the model to a data dictionary that contains the definitions.

• For a simple example that shows how to link a model to a data dictionary programmatically and
for information about configuring dictionary referencing programmatically, see “Store Data in
Dictionary Programmatically”.

• If you use a project, consider creating a project shortcut that creates a model and immediately
links the new model to a data dictionary. For information about projects and project shortcuts, see
“What Are Projects?”.

To manually share the definitions with a new model, see “Share Embedded Coder Dictionary
Definition Between Models” on page 31-12.

Migrate Package Definitions to Embedded Coder Dictionary to Use in
Code Mappings
If you create a storage class in a package and you want to use it in the Code Mappings editor, refer to
the package from one or more Embedded Coder Dictionaries. To refer to a package from an
Embedded Coder Dictionary, see “Refer to Code Generation Definitions in a Package”. Then, for
models that have access to the Embedded Coder Dictionary, you can apply storage classes from the
package by using the Code Mappings editor.

When you want to make changes to the definition, make changes only in the package. To apply the
changes to the Embedded Coder Dictionaries, refresh the package. To refresh the package, open each
Embedded Coder Dictionary.

To apply a storage class to a model data element that is not resolved to an external data object, use
the Code Mappings editor. To make the package definitions appear in the Code Mappings editor, refer
to the package from the Embedded Coder Dictionary that the model uses.

These unresolved model elements include:

• Inport blocks
• Outport blocks

 Manage an Embedded Coder Dictionary

31-21



• Signal lines
• Block states
• Data stores
• Parameter objects in the model workspace

To map these model elements to a package-based definition, refer to the package from the Embedded
Coder Dictionary that the model uses.

Beginning in R2020b, if an existing model includes these model elements and they are configured
with package-based definitions, Simulink references the package from the Embedded Coder
Dictionary. If the model is linked to a Simulink data dictionary, Simulink uses the Embedded Coder
Dictionary in the data dictionary to reference the package.

Change Code Generation Definitions
If the requirements for your generated code change, you might need to update your code definitions
to reflect the latest interface standards. Changing or deleting a code definition can affect models that
use the code definition. When you make changes to code definitions, assess the impact of the
changes. Then, deploy the changes and fix the affected usage points.

To make changes to definitions in a package, use the Custom Storage Class designer. For more
information, see “Create Storage Classes by Using the Custom Storage Class Designer” on page 38-
15.

To make changes to definitions in an Embedded Coder Dictionary:

• Use the Embedded Coder Dictionary tool, as described in Embedded Coder Dictionary.
• Use a script, as described in “Create Code Definitions Programmatically” on page 31-5. You can

write a script to automatically make a change to many code definitions in an Embedded Coder
Dictionary.

If you store the Embedded Coder Dictionary in a Simulink data dictionary, save the data dictionary
after you update the code definitions.

Assess the Impact of Code Definition Changes

Depending on the storage location of the code definition, changing or deleting the definition can
break usage points. This table shows the impact of different changes based on the location of the
definition. Check if usage points are affected by the change and fix them by making the
corresponding updates.

Definition Changes Storage Location Updates
Change the name of a definition Package For a memory section, update

other definitions in the package
that use the memory section. In
the Custom Storage Class
designer, specify the new
memory section name.
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Definition Changes Storage Location Updates
For a storage class, update data
objects that use the storage
class. Specify the new storage
class name for the data object.
In Embedded Coder Dictionaries
that reference the package,
refresh the package.
In models that use the definition
in the Code Mappings, specify
the new definition name. Use
either the Code Mappings editor
or a script that uses the
coder.mapping.api.CodeMap
ping object.

Embedded Coder Dictionary None
Change properties of a definition Package In Embedded Coder Dictionaries

that reference the package,
refresh the package.

Embedded Coder Dictionary None
Delete a definition Package For a memory section, update

other definitions in the package
that use the memory section. In
the Custom Storage Class
designer, specify a different
memory section or no memory
section.
For a storage class, update data
objects that use the storage
class. Specify a different storage
class or no storage class for the
data object.
In Embedded Coder Dictionaries
that reference the package,
refresh the package.
In models that use the definition
in the Code Mappings, specify a
different storage class or no
storage class. Use either the
Code Mappings editor or a script.

Embedded Coder Dictionary For a memory section, update
other definitions in the dictionary
that use the memory section.
Specify a different memory
section or no memory section.
Use either the Embedded Coder
Dictionary or a script.
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Definition Changes Storage Location Updates
In models that use the definition
in the Code Mappings, specify a
different storage class or no
storage class. Use either the
Code Mappings editor or a script.

Add a definition Package In Embedded Coder Dictionaries
that reference the package,
refresh the package.

Embedded Coder Dictionary None

Deploy Changes

See Also
Embedded Coder Dictionary

More About
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Deploy Code Generation Definitions” on page 31-10
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Migration of Memory Section and Shared Utility Settings from
Configuration Parameters to Code Mappings

For a model created in a release before R2018a, when you open the Embedded Coder app or use the
coder.mapping.create function, Simulink migrates memory section and shared utility settings
from the configuration parameters to the code mappings of the model. As part of the migration,
Simulink configures the Embedded Coder Dictionary that the model uses:

• To refer to the package that defines the memory sections, as described in “Refer to Code
Generation Definitions in a Package”.

• To contain a function customization template that specifies the naming rule and, if applicable,
memory section settings that you specified for shared utilities.

Effects of Migration
• The migration process makes changes to the model file, which you must save. The changes

include:

• Translating the configuration parameter settings into code mappings.
• If the model is not linked to a data dictionary, configuring the Embedded Coder Dictionary in

the model file to refer to the memory section package and to contain a function customization
template.

• If the model is linked to a data dictionary, the migration process makes changes to the dictionary,
which you must save. The changes include:

• If the configuration parameters are stored in the model file (the model does not refer to a
Simulink.ConfigSet object), configuring the Embedded Coder Dictionary of the data
dictionary to refer to the memory section package and to contain a function customization
template.

If the data dictionary references other dictionaries, the migration process configures the
dictionary at the bottom of the reference hierarchy so other models and dictionaries in the
hierarchy can use the memory section and function template definitions.

• If the model refers to a Simulink.ConfigSet object, configuring the Embedded Coder
Dictionary of the data dictionary that stores the object.

Considerations Before Migrating
• When you open the Embedded Coder app, Simulink executes the migration process. Do not open

the Embedded Coder app unless you are ready to migrate memory section and shared utility
naming settings.

If a model has multiple configuration sets (one active and one or more inactive) or refers to a
Simulink.ConfigSet object, the Embedded Coder app displays an informational message
indicating that information from the referenced configuration set has been imported into the
Embedded Coder Dictionary and code mappings.

• If you use Simulink data dictionaries, before you or other users open the Embedded Coder app for
a model, consider creating and configuring the dictionaries first.

In a hierarchy of referenced data dictionaries (for example, a dictionary hierarchy that parallels a
model hierarchy), only one dictionary can contain an Embedded Coder Dictionary. Setting up data
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dictionaries before migrating associated models enables you to control where the Embedded
Coder Dictionary resides in the dictionary hierarchy. Create or identify a data dictionary at the
bottom of the hierarchy so that models in the hierarchy can access the memory section and
function template definitions. Then, when you initiate migration by opening Embedded Coder app
for a model, Simulink configures that data dictionary.

For information about sharing an Embedded Coder Dictionary between models by using
referenced dictionaries, see “Share Embedded Coder Dictionary Definition Between Models” on
page 31-12.

• The migration process makes changes based on the active configuration set of the model (see
“Manage Configuration Sets for a Model”) when you open the model in the Embedded Coder app.
Before you open the model in the Embedded Coder app, activate the configuration set whose
settings you want the migration process to use.

The process ignores settings in inactive configuration sets. If different configuration sets of the
model specify different settings, you must choose one set to migrate.

Considerations After Migrating
• In a branching hierarchy of referenced models and referenced data dictionaries, after you or other

users migrate referenced models in different branches, opening the Embedded Coder app in a
parent model can generate an error due to the presence of multiple Embedded Coder Dictionaries
in the data dictionary hierarchy. To resolve these errors, use coder.dictionary.move and
coder.dictionary.remove to transfer and delete Embedded Coder Dictionaries until only one
dictionary remains. Place the remaining Embedded Coder Dictionary in a data dictionary at the
bottom of the hierarchy so that the models in the hierarchy can access the memory section and
function template definitions.

For information about sharing an Embedded Coder Dictionary between models by using
referenced dictionaries, see “Share Embedded Coder Dictionary Definition Between Models” on
page 31-12.

• After you migrate a model, memory section and shared utility model configuration parameters are
not accessible. If you use set_param or get_param to access these configuration parameter
settings programmatically, the functions generate errors. To change these settings, use the Code
Mappings editor or the programmatic interface as described in “C Data and Function
Configuration”.

If a model contains atomic subsystems that have nondefault memory section settings, you can
select the memory sections from built-in packages that are loaded into the Embedded Coder
Dictionary. See “Override Default Memory Placement for Individual Data Elements” on page 43-
6 and “Override Default Memory Placement for Subsystem Functions and Data” on page 43-
7.

• If a model refers to a Simulink.ConfigSet object, after migration, the model does not use the
memory section and shared utility settings in the object. If you used the object to set the
configuration parameters of multiple models:

• Changing memory section and shared utility settings in the object affects only models that you
have not migrated.

• Migrated models do not acquire memory section and shared utility settings from a single
location (the Simulink.ConfigSet object). To change the settings for these models, use the
Code Mappings editor of each model.
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See Also
Embedded Coder Dictionary | Code Mappings editor

Related Examples
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2
• “Generate Shared Utility Code” on page 7-56
• “C++ Data and Function Configuration”
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Flexible Storage Class for Different Model Hierarchy Contexts
This example shows how to use one storage class throughout a model hierarchy to generate code that
is unstructured for single-instance data and structured for multi-instance data. When a model
hierarchy contains single-instance and multi-instance data, use a flexible storage class to specify the
settings for the two contexts instead of creating two separate storage classes.

This example uses the single-instance top model ex_mdlreftop_dd, which references the multi-
instance model ex_mdlrefbot_dd three times. Both models share the data dictionary
ex_mdlref_dd.sldd. When you define the storage class in the shared data dictionary, you can apply
the class to data items in both models.

1 Open the example model ex_mdlreftop_dd.

addpath(fullfile(docroot,'toolbox','ecoder','examples'))
ex_mdlreftop_dd

2 Open the shared data dictionary. On the Modeling tab, click Design > Data Dictionary.
3 Open the shared Embedded Coder Dictionary. In the Model Explorer Model Hierarchy pane,

expand the ex_mdlref_dd node and click Embedded Coder Dictionary. In the right pane,
click Open Embedded Coder Dictionary.

4 To create a storage class, click Add.
5 For the new storage class, in the Property Inspector pane, set these property values:

• Name to MyStorageClass.
• Select Use different property settings for single-instance and multi-instance data.
• Single-instance storage > Storage Type to Unstructured.
• Multi-instance storage > Storage Type to Structured.

31 Representing a Software Architecture by Creating Code Generation Definitions

31-28



When you apply MyStorageClass to a data item, the Embedded Coder Dictionary implements
the single-instance settings or the multi-instance settings depending on the type of data and the
context of the model within the model reference hierarchy. Review the implementations for the
different settings in the pseudocode preview.

6 Apply the storage class to internal data items by specifying it as a dictionary default. In the
Embedded Coder Dictionary, click Configure Defaults. For the Signals, states, and internal
data row, set Storage Class to MyStorageClass. Click OK.

Because ex_mdlreftop_dd and ex_mdlrefbot_dd share the dictionary ex_mdlref_dd.sldd,
both models use MyStorageClass as the default storage class for internal data.

7 Open the Embedded Coder app for the model ex_mdlreftop_dd.
8 Generate code for the model.
9 Review the generated code for the referenced model. To open the referenced model in the editor,

double-click the Model block, CounterA. The reference model code appears in the Code view. In
ex_mdlrefbot_dd.h, the reference model code defines the storage class structure in which it
stores the internal data of the referenced model.

 Flexible Storage Class for Different Model Hierarchy Contexts

31-29



/* Storage class 'MyStorageClass', for model 'ex_mdlrefbot_dd' */
typedef struct {
  real_T PreviousOutput_DSTATE;        /* '<Root>/Previous Output' */
} ex_mdlrefbot_dd_MyStorageClass;

/* Real-time Model Data Structure */
struct ex_mdlrefbot_dd_tag_RTM {
  const char_T **errorStatus;
  ex_mdlrefbot_dd_MyStorageClass *MyStorageClass_ex_mdlrefbot_dd;
};

Because the referenced model is multi-instance, the definition implements the multi-instance
data settings of MyStorageClass. The reference model code stores the internal data in the
structure ex_mdlrefbot_dd_MyStorageClass.

10 Navigate back to the top model and review the generated code. In ex_mdlreftop_dd.c, the top
model code defines its internal data for each Model block by instantiating the storage class of the
referenced model, ex_mdlrefbot_dd_MyStorageClass.

/* Storage class 'MyStorageClass' */
ex_mdlrefbot_dd_MdlrefDW ex_mdlreftop_dd_CounterA_InstanceData;
ex_mdlrefbot_dd_MdlrefDW ex_mdlreftop_dd_CounterB_InstanceData;
ex_mdlrefbot_dd_MdlrefDW ex_mdlreftop_dd_CounterC_InstanceData;

/* Storage class 'MyStorageClass' */
ex_mdlrefbot_dd_MyStorageClass MyStorageClass_CounterA;

/* Storage class 'MyStorageClass' */
ex_mdlrefbot_dd_MyStorageClass MyStorageClass_CounterB;

/* Storage class 'MyStorageClass' */
ex_mdlrefbot_dd_MyStorageClass MyStorageClass_CounterC;

Because the top model is single-instance, these definitions implement the single-instance data
settings of MyStorageClass. The top model also packages its own internal data as standalone
variables by using the single-instance data settings. The top model code does not contain a
structure definition for internal data.

See Also
Embedded Coder Dictionary

Related Examples
• “Deploy Code Generation Definitions” on page 31-10
• “Organize Data into Structures in Generated Code” on page 34-145
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “Control Placement of Data in Memory by Inserting Pragmas” on page 34-67
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Separation of Code Definitions from Model-Specific Data and
Function Configurations

By using the Embedded Coder Dictionary, you can define specifications that control data and
functions in the generated code. You create custom specifications as code interface definitions, such
as storage classes, memory sections, and function customization templates. To configure your model
to use the definitions, map data items and functions in the model to the definitions.

Using an Embedded Coder Dictionary to specify your code, you can:

• Create, store, and maintain the specifications for your generated code in one place.
• Apply code definitions in the default mapping for your model.
• Configure the code for many different elements throughout your model.
• Choose how to apply your definitions with flexibility.
• Configure the generated code for multiple models.
• Use one model to generate code that is configured differently for different computing platforms.

Manage Code Specifications in One Location
When you create code definitions in an Embedded Coder Dictionary, you can manage the
specifications for your generated code in one place. You do not need to specify your code
customizations on each individual data item or function that you want to configure. By specifying your
code in the Embedded Coder Dictionary, you can:

• View and compare code definitions and their properties.
• Find and fix code specifications that do not conform to requirements.
• Change many code definitions quickly when software interface standards change.

Apply Definitions to Model Elements with Flexibility
Storing your code definitions in a dictionary gives you flexibility in applying the definitions to your
model because the code definitions in a dictionary are separate from the elements in your model.
Configure data elements and functions in your model by mapping them to code definitions. When you
map an item to a code definition, the code generated for that item reflects the specifications in your
code definition. To map model elements to code definitions, use the Code Mappings editor. You can
apply a code definition to one model element or to many model elements.

To configure many elements of the same type to use the same code definition, specify the definition in
the default mapping. When you map a category of data elements or functions to a code definition,
items in that category use the code definition by default for generating code. For example, if you want
the input ports in your model to generate code that reads data from a specific file, define the data
specifications in a storage class definition. Then, map the input ports data category to your storage
class. By default, the input ports of the model generate code that reads data according to the
specifications in your definition.

To configure an individual item to generate code according to its own specifications, map the item to
its own code definition. If the item is in a category for which you have already specified a default
mapping, the mapping for the individual item overrides the default mapping. The default and
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individual mappings enable you to configure many items in your model at once with the flexibility to
configure items individually.

Generate Standardized Code from Multiple Models
Separating code definitions from your model means that you can standardize the code generated
from many models by sharing one set of code definitions. Because the definitions in your Embedded
Coder Dictionary are separate from your model elements, you can share the definitions by storing the
Embedded Coder Dictionary in a Simulink data dictionary outside of your model. The figure shows an
example of two models sharing a dictionary. In the figure:

• modelA.slx and modelB.slx are separate models that generate code.
• Each model is linked to a Simulink data dictionary, in this case, the dictionaries are modelA.sldd

and modelB.sldd.
• The separate Simulink data dictionary, CodeDefinitions.sldd, contains the code interface
definitions.

• The dictionaries for the models, modelA.sldd and modelB.sldd, reference the dictionary
CodeDefinitions.sldd.

• For modelA and modelB, categories of model elements are mapped to the code definitions in
CodeDefinitions.sldd. Both models generate code that reflects the specifications in the
definitions.

To store your code definitions in a shared Simulink data dictionary:

1 Create a standalone Simulink data dictionary. In this dictionary, create code definitions to share
with multiple models.

2 From each model with which you want to share the code definitions, create and link a Simulink
data dictionary for model-specific design data.

3 From each model-specific data dictionary, reference the dictionary that contains the shared code
definitions.

For the models that are linked to the dictionary, you can configure the default mapping. In the shared
Embedded Coder Dictionary, such as CodeDefinitions.sldd, you can set the dictionary default
code definition for a category of model data or functions. Models that are linked to the dictionary use
the definition by default to generate code for the associated category of data or functions. You can
apply code interface definitions to your linked models by default without modifying the individual
models.
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You can still configure a linked model to use definitions that are different from the dictionary defaults.
In the linked model, configure the default mapping and the individual mapping by using definitions
that the model has access to, including definitions in the shared dictionary.

Generate Code for Different Platforms
By separating code definitions from your design data, you can generate code for different platforms
from the same model or model hierarchy. For each platform:

• Maintain a dictionary of code definitions that specify code interface behavior for the platform.
• The models map model elements to definitions in the dictionary for the platform.
• When you specify the associated system target file, the models use the mapping for the platform.

For example, you can share an Embedded Coder Dictionary with your models for an embedded real-
time (ERT) target platform. For each of the models, maintain a separate AUTOSAR dictionary with
definitions for an AUTOSAR platform. To configure the models for the ERT platform:

1 Specify an ERT-based system target file for the models.
2 Create code interface definitions in the shared Embedded Coder Dictionary.
3 For each model, in the Code Mappings editor, map categories of model elements and individual

model elements to definitions in the Embedded Coder Dictionary.

When you specify the ERT-based system target file, the models use this code mapping.

To configure the models for the AUTOSAR code generation target:

1 Specify an AUTOSAR-based system target file.
2 Create code definitions in the AUTOSAR dictionaries.
3 In the Code Mappings editor, map model elements and categories to the definitions in the

AUTOSAR dictionary.

When you specify the AUTOSAR-based system target file, the models use the AUTOSAR code
mapping.

To generate code for either platform, specify the system target file. The code mapping for the model
is updated to reflect the mapping and definitions that you specified for that platform.

See Also

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Deploy Code Generation Definitions” on page 31-10
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Generate C Messages to Communicate Between Simulink
Components

To generate C code that supports message-based communication between model components in the
Simulink environment, use the Simulink Messages & Events Library blocks Send and Receive. To
customize the communication, use the Queue block (from the same library) to set parameters for
capacity, sorting policy (LIFO, FIFO, and priority), and overwriting policy (behavior when the queue
exceeds capacity). You can generate C code for GRT-based system target files by using Simulink
Coder or for ERT-based system target files by using Embedded Coder.

Messages are an effective communication technique for distributed and complex systems that can be
modeled within Simulink. To better understand the generated code support for message-based
communication the following are explained:

• How to prepare models in Simulink for message-based communication.
• How model components pass messages and how the code implements this behavior.
• How to generate and examine C code from a given example model.

How to Prepare Models in Simulink for Message-Based Communication
In Simulink, you can model message-based communication between model components using these
steps:

1 Create a model that contains a Send block (referenced model).
2 Create a model that contains a Receive block (referenced model).
3 Create a model with two Model blocks (top model).

• Set the first Model block to the model that contains the Send block (model from step 1).
• Set the second Model block to the model that contains the Receive block (model from step 2).

4 When you run the model, a queue automatically generates in the top model above the message
line. A queue, explicit or implicit, controls the message communication. You can use the
automatically generated queue or you can add a Queue block in the top model to explicitly
specify communication parameters.

How Model Components Pass Messages and How the Code
Implements this Behavior
Conceptually, referenced models pass messages in the following way:

1 In the model that contains the Send block, the Send block converts signals into messages.
2 The top model that contains the queue manages messages according to parameters that define

capacity, order of delivery, and other quality of service (QoS) metrics.
3 In the model that contains the Receive block, the Receive block converts messages back to

signals.

In the generated C code, the top model facilitates the connection between the send and receive
referenced models by establishing a set interface that the referenced models can access
independently of one another.
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The generated C code implements message behavior in the following way:

1 A service is created at each model boundary. A service contains a reference to the top model and
an entry point function, referred to as a service function, for referenced models to use to pass
messages with the top model.

2 The top model initializes each service to create a connection to each referenced model.
3 The referenced models invoke service functions to pass messages with the top model.

Implementation details of these steps are shown in the generated code example.

C Code Generation Example
This example generates and examines C code from the model provided in “Establish Message Send
and Receive Interfaces Between Software Components”.

Generate C Code:

1 Open the model.
2 In the Apps gallery, click Embedded Coder.
3 For each model (top and both referenced models), in the Configuration Parameters dialog box, in

the Code Generation pane, set Language to C and save the model.
4 Generate code. On the C Code tab, click Build.
5 View the generated code. On the C Code tab, click View Code.

Examine C Code:

1 A service is created at each model boundary. In C, referenced models represent services as
DWork. The service provides a pointer to an instance of the top model and a service function that
referenced models invoke to pass messages.

a To view the service to send messages, open the send referenced model header file, mSend.h.
View the DWork allocation.

 Generate C Messages to Communicate Between Simulink Components

32-3



b To view the send message data type, if the data type is shareable (for example, built-in data
types, imported bus types, or exported bus types with a specified data type) the information
is located in a shared header file. If the data type is not shareable the information is located
the model header file, mSend.h. For this example, view the shareable data type by opening
the shared header file, SendData_real_T.h.

c To view the service to receive messages, open the receive referenced model header file,
mReceive.h. View the DWork allocation.

d To view the received messages data type, if the data type is shareable (for example,built-in
data types, imported bus types, or exported bus types with a specified data type) the
information is located in a shared header file. If the data type is not shareable the
information is located the model header file, mReceive.h. For this example, view the
shareable data type by opening the shared header file, RecvData_real_T.h.

2 The top model initializes each service to create a connection to each referenced model. In C, the
top model initializes each referenced model DWork. To view the initialization, open the top model
C file, MessageSendReceiveDefaultBufferModel.c.

3 The referenced models invoke service functions to pass messages with the top model. In C, a
referenced model invokes a service function by dereferencing the service function pointer and
passing a pointer to the instance of the top model. You can view the prototypes of the service
functions in the top model header file, and you can view the referenced model invocations of
those service functions in the referenced model C files.

a To view the prototype of the service function to send messages, open the top model header
file, MessageSendReceiveDefaultBufferModel.h.
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b To view the implementation of the service function to send messages, open the top model C
file, MessageSendReceiveDefaultBufferModel.c.

c To view how the send referenced model invokes the service function, open the C file for the
model, mSend.c. In the step function, the model invokes the service to send instance data
and a message to the top model and receives back a return status.

d To view the prototype of the service function to receive messages, open the top model
header file, MessageSendReceiveDefaultBufferModel.h.
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e To view the implementation of the service function to receive messages, open the top model
C file, MessageSendReceiveDefaultBufferModel.c.

f To view how the receive referenced model invokes the service function, open the C file for
the model, mReceive.c. In the step function, the model invokes the service to receive a
message payload and a return status.

Considerations and Limitations
• C code support is available for GRT-based system target files by using the Simulink Coder App.
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• C code support is available for ERT-based system target files by using the Embedded Coder App.
• To generate code, top and referenced models must have the same language (C) and system target
file selected.

• Function prototype control (FPC) cannot be configured for a top model that has root message
ports.

• External models and variant models are not supported.
• In simulation, SIL/PIL is not supported.

See Also

More About
• “Establish Message Send and Receive Interfaces Between Software Components”
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Generate C++ Messages to Communicate Between Simulink
Components

To generate C++ code that supports message-based communication between model components in
the Simulink environment, use the Simulink Messages & Events Library blocks Send and Receive. To
customize the communication, use the Queue block (from the same library) to set parameters for
capacity, sorting policy (LIFO, FIFO, and priority), and overwriting policy (behavior when the queue
exceeds capacity). You can generate C++ code for GRT-based system target files by using Simulink
Coder or for ERT-based system target files by using Embedded Coder.

Messages are an effective communication technique for distributed and complex systems that can be
modeled within Simulink. To better understand the generated code support for message-based
communication the following are explained:

• How to prepare models in Simulink for message-based communication.
• How model components pass messages and how the code implements this behavior.
• How to generate and examine the C++ code from a given example model.

How to Prepare Models in Simulink for Message-Based Communication
In Simulink, you can model message-based communication between model components using these
steps:

1 Create a model that contains a Send block (referenced model).
2 Create a model that contains a Receive block (referenced model).
3 Create a model with two Model blocks (top model).

• Set the first Model block to the model that contains the Send block (model from step 1).
• Set the second Model block to the model that contains the Receive block (model from step 2).

4 When you run the model, a queue automatically generates in the top model above the message
line. A queue, explicit or implicit, controls the message communication. You can use the
automatically generated queue or you can add a Queue block in the top model to explicitly
specify communication parameters.

How Model Components Pass Messages and How the Code
Implements this Behavior
Conceptually, referenced models pass messages in the following way:

1 In the model that contains the Send block, the Send block converts signals into messages.
2 The top model that contains the queue manages messages according to parameters that define

capacity, order of delivery, and other quality of service (QoS) metrics.
3 In the model that contains the Receive block, the Receive block converts messages back to

signals.

In the generated C++ code, the top model facilitates the connection between the send and receive
referenced models by establishing a set interface that the referenced models can access
independently of one another.
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The generated C++ code implements message behavior in the following way:

1 A service is created at each model boundary. A service contains a reference to the top model and
an entry point function, referred to as a service function, for referenced models to use to pass
messages with the top model.

2 The top model initializes each service to create a connection to each referenced model.
3 The referenced models invoke service functions to pass messages with the top model.

Implementation details of these steps are shown in the generated code example.

C++ Code Generation Example
This example generates and examines C++ code from the model provided in “Establish Message
Send and Receive Interfaces Between Software Components”.

Generate C++ Code:

1 Open the model.
2 In the Apps gallery, click Embedded Coder.
3 For each model (top and both referenced models), in the Configuration Parameters dialog box,

set these parameters:

• In the Code Generation pane, set Language to C++.
• In the Interface pane, set Code interface packaging to C++ class.

Save the model.
4 Generate code. On the C++ Code tab, click Build.
5 View the generated code. On the C++ Code tab, click View Code.

Examine C++ Code:

1 A service is created at each model boundary. In C++, services are represented as objects that
hold an instance of the top model and a service function that referenced models invoke to pass
messages.

a To view the creation of the services, open the top model C++ file,
MessageSendReceiveDefaultBufferModel.cpp. View the constructor method.
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The constructor methods, ReceiveComponentRecvData(*this) and
SendComponentSendData(*this), create the receive and send service objects
respectively by taking as an argument a reference to the instance of the top model. Each
service object saves a reference to the top model and defines the message interface (the
service functions RecvData and SendData).

b To view the receive and send service classes, open the top model header file,
MessageSendReceiveDefaultBufferModel.h, and view the following section.

2 The top model initializes each service to create a connection to each referenced model. To view
the initialization, open the top model C++ file,
MessageSendReceiveDefaultBufferModel.cpp. View the constructor method.
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The constructor method,
Receive_ComponentMDLOBJ0(get_ReceiveComponentRecvData()), passes a reference to
the receive service to the receive referenced model. The constructor method,
Send_ComponentMDLOBJ1(get_SendComponentSendData()), passes a reference to the send
service to the send referenced model.

3 The referenced models invoke service functions to pass messages with the top model. In C++,
referenced models invoke the top model (common ancestor, if in a hierarchy) service functions to
send or receive messages (specifically, a referenced model invokes the abstract service method
(RecvData or SendData) from the interface created in step 2).The abstract interface classes are
emitted to a shared folder. The implementation of the service functions in each service is defined
in the top model C++ file.

a To view the abstract interface class to send messages, open from the shared folder the
header file, SendData_real_T.h.

b To view the implementation of the service function to send messages, open the top model C+
+ file, MessageSendReceiveDefaultBufferModel.cpp.

c To view how the send referenced model invokes the service function, open its C++ file,
mSend.cpp. In the step function, the model invokes the service function to send messages to
the top model and receives back a return status.

d To view the abstract interface class to receive messages, open from the shared folder the
header file, RecvData_real_T.h.
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e To view the implementation of the service function to receive messages, open top model C++
file, MessageSendReceiveDefaultBufferModel.cpp.

f To view how the receive referenced model invokes the service function, open its C++ file,
mRecieve.cpp. In the step function, the model invokes the service function to receive
messages and a status from the top model.

Considerations and Limitations
• C++ code support is available for GRT-based system target files by using the Simulink Coder App.
• C++ code support is available for ERT-based system target files by using the Embedded Coder

App.
• To generate code, top and referenced models must have the same language (C++) and system

target file selected.
• Function prototype control (FPC) cannot be configured for a top model that has root message

ports.
• External models and variant models are not supported.
• In simulation, SIL/PIL is not supported.

See Also

More About
• “Establish Message Send and Receive Interfaces Between Software Components”
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Generate C++ Messages to Communicate Between Simulink
and an Operating System or Middleware

To generate C++ code that supports message communication between Simulink top models and
external applications, use the Simulink Messages & Events Library Send and Receive blocks.
Generating code from a top model to facilitate messages passed outside of the Simulink environment
enables your modeled application to communicate in a distributed system that uses an external
message protocol service, commonly referred to as an operating system or middleware (for example,
DDS, ROS, SOMEIP, or POSIX messages).

Simulink top models pass messages in the following way:

• Top models contain message blocks to communicate outside the Simulink environment. If a top
model contains a Send block directly connected to a root Outport block, the block converts its
signals into messages and passes them outside the Simulink environment. If a top model contains
a Receive block directly connected to a root Inport block, the block converts the received
messages into signals.

• The external message protocol manages the message communication according to its own
standard (policies that control capacity, order of delivery, and other quality of service (QoS)
behavior).

To generate C++ messages to communicate between Simulink top models and an operating system
or middleware, prepare your model, generate code, and integrate that code with your selected
operating system or middleware.

Prepare Model
To set up your model so that it can pass messages with an operating system or middleware, configure
the model as a top model that has at least one message block (a Send block connected to a root
Outport block or a Receive block connected to a root Inport block). The top model can then connect
to your selected operating system or middleware through the message blocks as shown:

Within a model, the message ports are connected as shown:
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Generate Code
To generate C++ code from a model:

1 In the Apps gallery, click Embedded Coder.
2 In the Configuration Parameters dialog box, set these parameters:

• In the Code Generation pane, set the Language to C++.
• In the Interface pane, set Code interface packaging to C++ class.
• In the Templates pane, select Generate an example main program.

3 Generate code. On the C++ Code tab, click Build.
4 View the generated code. On the C++ Code tab, click View Code.

Integrate Code
To integrate the generated C++ code from your model with your selected operating system or
middleware use handwritten code to implement send and receive message classes and application
code that uses those classes to pass messages. Specifically:

1 If you use your own main, create concrete subclasses from the generated abstract classes shown
in RecvData_<T>.h and SendData<T>.h. If you use the generated example main program,
concrete subclasses are provided for you in the file.

2 Implement the class functions SendData and RecvData to call into your selected operating
system or middleware to send and receive messages.

3 Create an instance of your implemented send and receive message classes (send and receive
objects).

4 Create an instance of the model class by using the instances of each message class (send and
receive objects) as arguments in the model constructor.

5 Send and receive messages as required by your application. You are expected to manage the
lifetime of the message queues. It is required that the queues are in a state ready to accept
messages prior to the first step of the model.

To integrate:

1 Open the generated example main program (or create your own). If you use the generated
example main program, the concrete subclasses RecvData_real_T and SendData_real_T are
provided in the file. If you create your own main, create concrete subclasses in your application
code:
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2 To receive messages, hand write the implementation of the generated receive class. Implement
the class function RecvData to call into your selected operating system or middleware to receive
messages.

An example implementation for POSIX is shown:

class mHMIHandlerRecvData_real_T: public RecvData_real_T {
    public:
    void RecvData(real_T* data, int32_T length, int32_T* status)
    {
        // Use POSIX API mq_receive to receive messages
        unsigned int priority = 1;
        *status = mq_receive(msgQueue, (char *)data, length, &priority);
    }
};

Create a receive object.

static mHMIHandlerRecvData_real_T InMsgRecvData_arg;
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3 To send messages, hand write the implementation of the generated send class. Implement the
class function SendData to call into your selected operating system or middleware to send
messages.

An example implementation for POSIX is shown:

class mHMIHandlerSendData_real_T : public SendData_real_T {
    public:
    void SendData(const real_T* data, int32_T length, int32_T* status)
    {
        // Use the POSIX API mq_send to send messages
        unsigned int priority = 1;
        *status = mq_send(msgQueue, (char*)data, length, priority);
    }
};

Create a send object.

static mHMIHandlerSendData_real_T OutMesgSendData_arg;

Create an instance of the model class by using your send and receive objects as arguments in the
model constructor.

static mHMIHandler mHMI_Obj(InMsgRecvData_arg, OutMsgSendData_arg);
4 Send and receive messages as required by your application and maintain the lifetime of the

message queue.

An example implementation for POSIX is shown:

int_T main(int_T argc, const char *argv[])
{
    // Unused arguments
    (void)(argc);
    (void)(argv);

    //Initialize model
    mHMI_obj.initialize();     

    // Open POSIX queue
     mqd_t msgQueue = mq_open("/PosixMQ_Example", O_RDONLY);
     if (msgQueue == -1)
     {
         printf("mq_open failed\n");
         exit(1);
     }     

    // Send and Receive messages
     while (rtmGetErrorStatus(mHMI_Obj.getRTM()) == (NULL)) {
         //perform application tasks here.
         rt_OneStep();
     }   

    // Close POSIX queue
     mq_close(msgQueue);     

    // Terminate model
     mHMI_Obj.terminat():
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     return 0;
 }

For a more complex POSIX integration example, see “Use Handwritten Code to Integrate C++
Messages with POSIX” on page 32-18

Considerations and Limitations
• Handwritten code is the only supported integration technique.
• The parameter Generate an example main program must be selected. Applications that require

a static main are not supported.
• Function prototype control (FPC) cannot be configured for a top model that has root message

ports.

See Also

More About
• “Use Handwritten Code to Integrate C++ Messages with POSIX” on page 32-18
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Use Handwritten Code to Integrate C++ Messages with POSIX
This example shows how to integrate generated C++ code with POSIX to facilitate message
communication. The example application is a multisensor positioning system designed to estimate the
position of a vehicle. The multisensor positioning system is composed of two components: sensors
(multiple models) and an estimation model. The outlined workflow shows how to prepare each
component, generate code, and integrate the generated code to pass messages between system
components. This example assumes you are familiar with using messages in the Simulink
environment. For more information, see “Generate C++ Messages to Communicate Between
Simulink and an Operating System or Middleware” on page 32-13.

Sensor Models

The first component in the multisensor positioning system is the sensors. The positioning system uses
an accelometer and a GPS sensor to estimate the vehicle position. Each sensor model is composed of
a Function block, Send block, and Output port. Each sensor model sends messages to the estimation
model by using POSIX messages.

Prepare Models

Open the sensor models rtwdemo_accel_send and rtwdemo_gps_send.

For each model, perform these steps:

1 In the Apps Gallery, click Embedded Coder.
2 On the toolstrip, set the Stop time to 100 seconds. The stop time defines the duration of the

data collection when estimating the vehicle position.
3 In the model, click to open the Function block. In the Block Parameters, set the File name to the

MAT-file for the model. Set the Sample time to 0.01.

Generate Code

1. For each sensor model, in the Configuration Parameters dialog box, set these parameters:

• On the Code Generation pane, set Language to C++. Under Advanced parameters, set Build
configuration to Specify and add -lrt to the C++ Linker.

• On the Interface pane , set Code interface packaging to C++ class and Multi-instance code
error diagnostic to none. Under Advanced parameters, select MAT-file logging.

2. Generate code. On the C++ Code tab, click Build.
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Integrate Code

To integrate the generated C++ code from each sensor model with POSIX, hand write the
implementation of the send class and generated main program (or create your own). This example
provides a customized main program with an implemented send class. To integrate the code from
each sensor model, replace the generated main file with the customized main file.

Review the customized main file for each sensor:

1. The customized main file for each sensor is implemented in the same way. As an example, open the
customized main file rtwdemo_accel_send_ert_main_customized.cpp.

2. Review the implemented send class:

• The send class function, SendData, calls into the POSIX API (mq_send) to send messages.
• To provide access to a message queue, a POSIX message queue is added as a class variable and a

set method is implemented to set the queue.

class accelSendModelClassSendData_real_T : public SendData_real_T{
     mqd_t msgQueue;

     public:
     // Use POSIX to send messages
     void SendData(const real_T* data, int32_T length, int32_T* status)
     {
         unsigned int priority = 1;
         *status = mq_send(msgQueue, (char*)data, length, priority);
     }

     // Set method for class POSIX queue
     void SetMQ(mqd_t mq)
     {
         msgQueue = mq;
     }
 };

After the send class implementation, an instance of the send class (a send object) is created. The send
object is then attached to the sensor model to enable the sensor to send messages to the estimate
model.

// Create send object
static accelSendModelClassSendData_real_T Out1SendData_arg;

// Attach send object to sensor model to send messages
static accelSendModelClass rtObj( Out1SendData_arg);

3. Review the added POSIX queue behavior functions. The main function uses these functions to open
and close the POSIX queue.

mqd_t openMQ(const char *name, int flags, int maxmsg, int msgsize)
 {
     struct mq_attr attr;
     attr.mq_flags = 0;
     attr.mq_maxmsg = maxmsg;
     attr.mq_msgsize = msgsize;

     mqd_t msgQueue = mq_open(name, flags, 0664, &attr);
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     if (msgQueue < 0) {
         printf("mq_open failed\n");
         exit(1);
     }

     return msgQueue;
 }

void closeMQ(mqd_t msgQueue)
 {
     mq_close(msgQueue);
 }

4. Review the main function. The implemented main function uses the previously defined class and
queue functions to send messages and to manage the POSIX message queue. The main function
performs the following:

• Opens a POSIX message queue.
• Sends messages.
• Closes the POSIX queue.

int_T main(int_T argc, const char *argv[])
 {
     // Unused arguments
     (void)(argc);
     (void)(argv);

     // Initialize model
     rtObj.initialize();

     // Open POSIX message queue
     mqd_t msgQueue = openMQ("/PosixMQ_accel", O_CREAT | O_WRONLY, 2, 16);
     Out1SendData_arg.SetMQ(msgQueue);

     // Send messages
     while (rtmGetErrorStatus(rtObj.getRTM()) == (NULL)) {
     rt_OneStep();
     }

     // Matfile logging
     rt_StopDataLogging(MATFILE, rtObj.getRTM()->rtwLogInfo);

     // Disable rt_OneStep() here

     // Close POSIX message queue
     closeMQ(msgQueue);

     return 0;
 }

Estimate Model

The second component is the estimate model. The estimate model receives messages that have input
data from the sensor models and calculates the estimated position of the vehicle.

Prepare Model

Open the model rtwdemo_pos_estimate.
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1 In the Apps Gallery, click Embedded Coder.
2 On the toolstrip, set the Stop time to 100 seconds.
3 In the model, click to open each inport. In the Block Parameters, set Data type to double, Port

dimensions to 3, and Sample time to 0.01.
4 Click to open each Message Receive block. Clear the Use internal queue parameter to enable

the model to use a POSIX message queue.
5 Click to open the Function block. This block implements the estimation algorithm.

Generate Code

1. In the Configuration Parameters dialog box, set these parameters:

• On the Code Generation pane, set Language to C++. Under Advanced parameters, set Build
configuration to Specify and add -lrt to the C++ Linker.

• On the Interface pane, set Code interface packaging to C++ class and set Multi-instance
code error diagnostic to none. Under Advanced parameters, select MAT-file logging.

2. Generate code. On the C++ Code tab, click Build.

Integrate Code

To integrate the generated C++ code from the estimate model with POSIX, hand write the
implementation of the receive class and generated main program (or create your own). The estimate
model receives messages from the sensor models and calculates an estimated position of the vehicle.
This examples provides a customized main program with an implemented receive class. To integrate
the code from the estimate model, replace the generated main file with the customized main file.

Review the customized main file:

1. Open the customized main file rtwdemo_pos_estimate_ert_main_customized.cpp.

2. Review the implemented receive class:

• The receive class function, RecvData, calls into the POSIX API (mq_receive) to receive
messages.
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• To provide access to a message queue, a POSIX message queue is added as a class variable and a
set method is implemented to set the queue.

class positionEstimateModelClassRecvData_real_T : public RecvData_real_T{
     mqd_t msgQueue;

     public:
     // Uses POSIX API mq_receive to receive messages
     void RecvData(real_T* data, int32_T length, int32_T* status)
     {
     // Add receive data logic here
     unsigned int priority = 1;
     *status = mq_receive(msgQueue, (char *)data, length, &priority);
     }

     // Set method for class POSIX queue
     void SetMQ(mqd_t mq)
     {
         msgQueue = mq;
     }
  };

After the receive class implementation, an instance of the receive class (a receive object) is created
for each sensor model. The receive objects are then attached to the estimate model to enable the
model to receive messages from each sensor.

// Create receive objects
static positionEstimateModelClassRecvData_real_T In1RecvData_arg;
static positionEstimateModelClassRecvData_real_T In2RecvData_arg;

// Attach receive objects to estimate model to receive messages
static positionEstimateModelClass rtObj( In1RecvData_arg, In2RecvData_arg);

3. Review the added POSIX queue behavior functions. The main function uses these functions to
open, close, and unlink the POSIX queue.

mqd_t openMQ(const char *name, int flags, int maxmsg, int msgsize)
 {
     struct mq_attr attr;
     attr.mq_flags = 0;
     attr.mq_maxmsg = maxmsg;
     attr.mq_msgsize = msgsize;

     mqd_t msgQueue = mq_open(name, flags, 0664, &attr);

     if (msgQueue < 0) {
         printf("mq_open failed\n");
         exit(1);
     }

     return msgQueue;
 }

void closeMQ(mqd_t msgQueue)
 {
     mq_close(msgQueue);
 }

void unlinkMQ(const char *name)
 {
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     if (mq_unlink(name) < 0) {
         printf("mq_unlink failed\n");
         exit(1);
     }
 }

4. Review the main function. The implemented main function uses the previously defined class and
queue functions to receive messages and to manage the POSIX queue. The main function performs
the following:

• Opens a POSIX message queue.
• Receives messages.
• Closes the POSIX queue.

int_T main(int_T argc, const char *argv[])
 {
     // Unused arguments
     (void)(argc);
     (void)(argv);

     // Initialize model
     rtObj.initialize();

     // Open POSIX message queues
     mqd_t msgQueueAccel = openMQ("/PosixMQ_accel", O_CREAT | O_RDONLY, 2, 16);
     mqd_t msgQueueGPS = openMQ("/PosixMQ_gpspos", O_CREAT | O_RDONLY, 2, 16);

     In1RecvData_arg.SetMQ(msgQueueAccel);
     In2RecvData_arg.SetMQ(msgQueueGPS);

     // Receive messages
     while (rtmGetErrorStatus(rtObj.getRTM()) == (NULL)) {
         rt_OneStep();
     }

     // Matfile logging
     rt_StopDataLogging(MATFILE, rtObj.getRTM()->rtwLogInfo);

     // Disable rt_OneStep() here

     // Close POSIX message queues
      closeMQ(msgQueueAccel);
      closeMQ(msgQueueGPS);

      unlinkMQ("/PosixMQ_accel");
      unlinkMQ("/PosixMQ_gpspos");

     return 0;
 }

Execute Multisensor Positioning System

To execute the multisensor positioning system, rebuild and run the executables for all models. To
view results, run the provided build script rtwdemo_positioning_system_script. An example of
results is shown in this figure.
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Configuring Data and Functions in the
Generated Code

• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Code Definition and Mapping Limitations and Considerations” on page 33-11
• “Configure Default C Code Generation for Categories of Data Elements and Functions”

on page 33-15
• “Configure Root-Level Inport Blocks for C Code Generation” on page 33-30
• “Configure Root-Level Outport Blocks for C Code Generation” on page 33-42
• “Configure Signal Data for C Code Generation” on page 33-51
• “Configure Parameters for C Code Generation” on page 33-62
• “Configure Block States for C Code Generation” on page 33-75
• “Configure Data Stores for C Code Generation” on page 33-83
• “Manage Multiple Code Mappings for a Model” on page 33-92
• “Configure Model Data Interface for C Code Generation” on page 33-95
• “Migration of Model Data Configurations to Code Mappings” on page 33-102
• “Dimension Preservation of Multidimensional Arrays” on page 33-109
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Configure Multi-Instance Code Generation” on page 33-129
• “Configure Data Interfaces” on page 33-130
• “Configure Entry-Point Function Interfaces” on page 33-131
• “Configure Internal Data” on page 33-133
• “Configure Subsystem Function Packaging and Interface” on page 33-134
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C Code Generation Configuration for Model Interface Elements
The code generator provides tooling for you to control the representation of the data and, if you have
Embedded Coder, entry-point functions in the generated code. For example, you can configure data
and functions for code generation to comply with code standards and guidelines, integrate generated
code with external code, or address memory requirements.

The code generator produces code for model data elements and functions:

• Data such as inports, signals, states, and parameters, which your application code can read from
and write to.

• Entry-point functions such as model_step, which your application code calls to execute the
model algorithm.

You can configure model data elements and functions for code generation by using the Code
Mappings editor or code mappings programming interface (coder.mapping.api.CodeMapping).
Embedded Coder is required to configure functions. For data elements, use the Code Mappings editor
or code mappings API instead of, or in addition to, creating and configuring Simulink data objects.
The editor and API enable you to configure:

• Default code generation settings that apply throughout a model for a category of data elements or
functions

• Configuration settings that apply to individual data elements or functions

This diagram shows the overall workflow:

Migration
When you open a model created in a release before R2020b, Simulink® migrates code definitions
specified in the model to the model code mappings.

If necessary, as part of the migration, Simulink configures the Embedded Coder Dictionary that the
model uses. When you save the model, the code mappings are saved as part of the model.

For more information, such as effects of migration and what to consider before migrating, see
“Migration of Model Data Configurations to Code Mappings” on page 33-102 .
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Code Definitions
Code definitions include storage classes, function customization templates, and memory sections. A
storage class defines properties, such as appearance and location, that the code generator uses when
producing code for the associated data. A function customization template defines how the code
generator produces code for functions. For a function category, you can define a rule for naming
functions and a location in memory for function definitions (memory section).

Memory sections control the placement of data and function definitions in memory. In some cases,
you can select a specific memory section that you want when configuring data elements and
functions.

The code generator provides predefined code definitions for data elements. If you have Embedded
Coder, you can use the Embedded Coder Dictionary to create and share code definitions, for example,
to standardize code that you generate from multiple models or to create definitions for different
application run-time environments. Creating custom definitions enables you to achieve code
generation objectives that predefined definitions cannot satisfy. For data elements, you also have the
option of creating code definitions created in packages by using Embedded Coder Custom Storage
Class Designer.

Code definitions that you create by using the Embedded Coder dictionary appear in the Code
Mappings editor and are accessible by using the code mappings API. For some definitions that you
create by using the Custom Storage Class Designer, you can make the definitions appear in the Code
Mappings editor by configuring an Embedded Coder Dictionary to refer to them.

By default, code definitions that you create by using the Embedded Coder Dictionary for a model are
stored in the model file. You can share code definitions between models and projects by storing the
definitions in a Simulink data dictionary. With a data dictionary, to modify a shared definition, you
change a definition in one place—the Embedded Coder Dictionary.

For more information, see “Define Storage Classes, Memory Sections, and Function Templates for
Software Architecture” on page 31-2 and “Create Storage Classes by Using the Custom Storage Class
Designer” on page 38-15.

Data Default Configurations
Reduce the effort of preparing a model for C code generation by specifying default configurations for
categories of data elements, for example inports or model workspace parameters, across a model.
Applying default configurations can save time and reduce the risk of introducing errors in code,
especially for larger models and models from which you generate multi-instance code.

Default configurations apply throughout a model, excluding referenced models. Simulink saves a
separate set of code mappings as part of each model in a model reference hierarchy.

If a model includes a significant number of elements of a given category (for example, more than 10),
it is more efficient to configure the category by using a default setting, and then override that setting
for special cases.

The default settings can help you to reduce manual data entry.

• As you add blocks and signals to a model, new data elements inherit the default settings.
• To change code generation settings for many data elements at once, make the changes in one

place—the default settings.
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• For efficiency, use naming rules as you make changes elsewhere in the model.

You configure data defaults by using the Code Mappings editor Data Defaults tab or the
setDataDefault function.

Model Data Categories

You configure data defaults by using the Code Mappings editor Data Defaults tab or the
setDataDefault function. In the Data Defaults tab or function call, you can select or specify these
categories of data elements.

Model Element Category Description
Inports Root-level input ports of a model, such as Inport and In Bus

Element blocks.
Outports Root-level output ports of a model, such as Outport and Out Bus

Element blocks.
Signals, states, and internal data Data elements that are internal to the model, such as block output

signals, discrete block states, data stores, and zero-crossing
signals.

Shared local data stores Data Store Memory blocks that have the block parameter Share
across model instances set. These data stores are accessible
only in the model where they are defined. The data store value is
shared across instances of the model.

Global data stores Data stores that are defined by a signal object in the base
workspace or in a data dictionary. Multiple models in an
application can use these data stores. To view and configure these
data stores in the Code Mappings editor, click the Refresh link
to the right of the category name. Clicking this link updates the
model diagram.

Model parameter arguments Parameters in the model workspace that you configure as model
arguments. These parameters are exposed at the model block to
enable each model instance to provide its own value. To specify a
parameter as a model argument, select the Model Data Editor >
Parameters > Argument check box.

Model parameters Parameters that are defined within a model, such as parameters
in the model workspace. Excludes model arguments.

External parameters Parameters that you define as objects in the base workspace or in
a data dictionary. Multiple models in an application can use these
parameters. To view and configure these parameters in the Code
Mappings editor, click the Refresh link to the right of the
category name. Clicking this link updates the model diagram.

Constants Constant-value block output and parameters that could not be
inlined. These values are stored in variables for one of the
following reasons.

• The value is an array larger than the loop unrolling threshold.
• The value address is needed in the code.

If you set the default storage for a category of data elements to Default, you have the option of
specifying a memory section.
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Considerations for Configuring Default Code Generation Settings for Data

Before configuring default code generation settings for data elements, take into account the
considerations listed in this table.

Consideration More Information
What categories are relevant to your model? The data element categories in the preceding

table
Does the model use several instances of data that
is in a category? If the answer is yes, applying
default mappings is beneficial. Otherwise,
consider configuring code generation for each
data element individually.

• “Configure Root-Level Inport Blocks for C
Code Generation” on page 33-30

• “Configure Root-Level Outport Blocks for C
Code Generation” on page 33-42

• “Configure Signal Data for C Code
Generation” on page 33-51

• “Configure Parameters for C Code
Generation” on page 33-62

• “Configure Block States for C Code
Generation” on page 33-75

• “Configure Data Stores for C Code
Generation” on page 33-83

Which storage class aligns with your code
generation requirements for each category?

“Choose Storage Class for Controlling Data
Representation in Generated Code” on page 34-
74

Do you want model data to be structured? For
example, if you configured the model for multi-
instance code generation, structures can improve
code efficiency and readability.

“Organize Data into Structures in Generated
Code” on page 34-145

Is the code generator required to store data in
specific areas of memory? For example, consider
whether to store initialization data in slow
memory and algorithmic or computational data in
fast memory.

• “Define Storage Classes, Memory Sections,
and Function Templates for Software
Architecture” on page 31-2

• “Control Data and Function Placement in
Memory by Inserting Pragmas” on page 43-
2

Do you want to prevent optimizations from
eliminating specific data from the code?

“Elimination of Categories of Data by
Optimizations” on page 33-6

Do you need to define new storage classes that
you can select in the Code Mapping editor?

• “Define Storage Classes, Memory Sections,
and Function Templates for Software
Architecture” on page 31-2

• “Create Storage Classes by Using the Custom
Storage Class Designer” on page 38-15

After you configure one or more categories of model elements, setting memory sections and Shared
utilities identifier format model configuration parameters has no effect on the model configuration.
When you open a coder app, Simulink migrates the model configuration parameter settings to the
Code Mappings editor. As part of the migration, Simulink configures the Embedded Coder Dictionary
that the model uses, as described in “Migration of Memory Section and Shared Utility Settings from
Configuration Parameters to Code Mappings” on page 31-25.
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Elimination of Categories of Data by Optimizations

Code generation optimizations can eliminate data from the code, which means your application code
cannot interact with the data. For general information about data elimination by optimizations, see
“How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49.

The optimizations can eliminate data in these categories only:

• Model parameters
• Model parameter arguments
• External parameters
• Internal data

After eliminating data with optimizations, the code generator applies the default code generation
settings in the code mappings to the remaining data. For parameters and signal lines, optimizations
can eliminate data for an entire category. If this elimination occurs, default settings that you specify
for that category do not apply to data.

To prevent optimizations from eliminating individual data elements, explicitly apply a storage class to
the individual element. The storage class controls the appearance of the data in the generated code.
To force a data element to use the default storage class that you specify, explicitly apply the storage
class Model default. See “Choose Storage Class for Controlling Data Representation in Generated
Code” on page 34-74.

Shared Dictionary Data Defaults

If you link a model to a Simulink data dictionary, which includes a coder dictionary that configures
default code definitions for categories of data, you can use the Code Mappings editor to apply the
dictionary defaults. In the Code Mappings editor, on the Data Defaults tab, select a category and set
the storage class to Dictionary Default. If someone makes a change to the default settings in the
shared coder dictionary, the code generator applies the updated default settings when producing
code for your model. See “Configure Default Code Mapping in a Shared Dictionary” on page 31-10.

Function Default Configurations
Reduce the effort of preparing a model for C code generation by specifying default configurations for
categories of and functions, such as initialize/terminate and execution functions, across a model.
Applying default configurations can save time and reduce the risk of introducing errors in code,
especially for larger models and models from which you generate multi-instance code.

Default configurations apply throughout a model, excluding referenced models. Simulink saves a
separate set of code mappings as part of each model in a model reference hierarchy.

If a model includes a significant number of functions of a given category (for example, more than 10),
it is more efficient to configure the category by using a default setting, and then override that setting
for special cases.

The default settings can help you to reduce manual data entry.

• As you add blocks and signals to a model, new functions inherit the default settings.
• To change code generation settings for many functions at once, make the changes in one place—

the default settings.
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• For efficiency, use naming rules as you make changes elsewhere in the model.

Model Function Categories

You configure function defaults by using the Code Mappings editor Function Defaults tab or the
setDataDefault function. In the Function Defaults tab or function call, you can select or specify
these categories of functions.

Model Function Category Description
Initialize/Terminate Entry-point functions for initialization and

termination
Execution Entry-point functions for initiating execution and

resets
Shared utility Shared utility functions

The code generator uses default naming rules to name entry-point functions. To integrate generated
code with existing external code or to comply with naming standards or guidelines, you can adjust the
default naming rule. Adjusting the default naming rule can save time, especially for multirate models
for which the code generator produces a unique step function for each rate.

You might need to define a function customization template in the Embedded Coder Dictionary.
Unless someone has defined function customization templates for a model, the Code Mappings editor
presents Default as the only template option.

Considerations for Configuring Default Code Generation Settings for Functions

Before configuring default code generation settings for functions, take into account the
considerations listed in this table.

Consideration More Information
What categories are relevant to your model? The function categories in the preceding table
Does the model use several instances of functions
that are in a category? If the answer is yes,
applying default mappings is beneficial.
Otherwise, consider configuring code generation
for each function individually.

“Configure C Code Generation for Model Entry-
Point Functions” on page 33-112

Which function customization template aligns
with your code generation requirements for each
category?

“Define Storage Classes, Memory Sections, and
Function Templates for Software Architecture” on
page 31-2

Do categories require the code generator to store
function code in specific areas of memory? For
example, consider whether to store initialization
data in slow memory and algorithmic or
computational data in fast memory.

• “Define Storage Classes, Memory Sections,
and Function Templates for Software
Architecture” on page 31-2

• “Control Data and Function Placement in
Memory by Inserting Pragmas” on page 43-
2
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Consideration More Information
Do you need to define new function customization
templates that you can select in the Code
Mapping editor?

• “Define Storage Classes, Memory Sections,
and Function Templates for Software
Architecture” on page 31-2

• “Create Storage Classes by Using the Custom
Storage Class Designer” on page 38-15

Do you have function naming requirements? If
the answer is yes, what are they? To which
categories do the requirements apply?

• “Configure C Code Generation for Model
Entry-Point Functions” on page 33-112

• “Identifier Format Control” on page 53-15

After you configure one or more categories of model elements, setting memory sections and Shared
utilities identifier format model configuration parameters has no effect on the model configuration.
When you open a coder app, Simulink migrates the model configuration parameter settings to the
Code Mappings editor. As part of the migration, Simulink configures the Embedded Coder Dictionary
that the model uses, as described in “Migration of Memory Section and Shared Utility Settings from
Configuration Parameters to Code Mappings” on page 31-25.

Shared Dictionary Function Defaults

If you link a model to a Simulink data dictionary, which includes a coder dictionary that configures
default code definitions for categories of functions, you can use the Code Mappings editor to apply
the dictionary defaults. In the Code Mappings editor, on the Function Defaults tab, select a category
and set the function customization template to Dictionary Default. If someone makes a change
to the default settings in the shared coder dictionary, the code generator applies the updated default
settings when producing code for your model. See “Configure Default Code Mapping in a Shared
Dictionary” on page 31-10.

Configurations for Individual Data Elements and Functions
After you configure model-wide default settings, you can override the defaults for individual data
elements and functions. An individual data element or function configuration applies to a specific data
element or function in a model. Configure data elements and functions individually when:

• The model includes a few elements of a given category that have unique source, naming, or
placement requirements.

• You configured default settings and you want to override the default setting for an individual
element.

For individual data elements, initially the storage class is set to Auto, which means that the code
generator might eliminate or change the representation of relevant code for optimization purposes. If
optimizations are not possible, the code generator applies the model default configuration.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that data element.

If a data element in a model is unnamed (for example, a signal has no label or a state has no name),
you must specify a code identifier for the data element when configuring it for C code generation. Set
the code identifier by specifying a value for the storage class property Identifier.
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For individual functions, you can customize the function name. For execution functions, such as the
step functions and Simulink functions for a model, you can configure function arguments.

Configure Data
1 Open the Embedded Coder app.
2 Configure default mappings for categories of data elements. Select Code Interface > Default

Code Mappings. In the Code Mappings editor, on the Data Defaults tab,select a model element
category and set the storage class. In the Property Inspector, set storage class properties to align
with model requirements.

If you need to define a storage class, use the Embedded Coder Dictionary. Select Code Interface
> Embedded Coder Dictionary.

3 Decide whether to override default configuration settings for individual data elements. If you
choose not to override settings, go to step 8.

4 Identify MATLAB variables that you want to configure individually and store the configurations in
the model file. In the Model Explorer, convert the variables to Simulink.Parameter objects.
The resulting data objects appear in the Code Mappings editor as model parameters.

5 Identify signals representing algorithm data that you want to monitor while the generated code
executes and configure those signals individually. For each signal that you identify, do one of the
following:

• For signal data that is specific to a model (not shared), add the signals to the Code Mappings
editor.

• For shared signal data, create and configure Simulink.Signal objects.
6 Configure individual data elements. In the Code Mappings editor, click a category tab, select a

data element, and set the storage class. In the Property Inspector, set storage class property
values. To change the setting of model configuration parameter Default parameter behavior,
click the link indicating the behavior when the storage class is set to Auto. In the Model
Configuration Parameters dialog box, change the parameter setting to Tunable or Inline.

For information on configuring specific types of data elements, see:
7 To view and configure external data objects that are stored in the base workspace or a data

dictionary, in the Code Mappings editor, on the Data Defaults tab, click the Refresh link to the
right of the category name.

8 Generate and review code.

For more details and examples, see:

• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” on
page 31-2

• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page
33-15

• Code Mappings editor
• “Configure Root-Level Inport Blocks for C Code Generation” on page 33-30
• “Configure Root-Level Outport Blocks for C Code Generation” on page 33-42
• “Configure Signal Data for C Code Generation” on page 33-51
• “Configure Parameters for C Code Generation” on page 33-62
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• “Configure Block States for C Code Generation” on page 33-75
• “Configure Data Stores for C Code Generation” on page 33-83
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112

Configure Functions
1 Open the Embedded Coder app.
2 Configure default mappings for categories of functions. Select Code Interface > Default Code

Mappings. In the Code Mappings editor, on the Function Defaults tab, select a function
category and set the function customization template.

You might need to define a function customization template. Templates are not available by
default. To define a function customization template, use the Embedded Coder Dictionary. Select
Code Interface > Embedded Coder Dictionary.

3 Decide whether to override default configuration settings for individual functions. If you choose
not to override settings, go to step 5.

4 Configure individual entry-point functions. In the Code Mappings editor, click Functions tab,
select a function, and set the function customization template. Alternatively, you can specify a
function name. For execution functions, such as a model step function, you can customize the
function arguments. Clicking a function preview link opens a dialog box that you can use to
customize the entire function interface.

5 Generate and review code.

For more details and examples, see:

• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” on
page 31-2

• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15

See Also
Code Mappings editor | Embedded Coder Dictionary | coder.mapping.api.CodeMapping

More About
• “Configure Root-Level Inport Blocks for C Code Generation” on page 33-30
• “Configure Root-Level Outport Blocks for C Code Generation” on page 33-42
• “Configure Signal Data for C Code Generation” on page 33-51
• “Configure Parameters for C Code Generation” on page 33-62
• “Configure Block States for C Code Generation” on page 33-75
• “Configure Data Stores for C Code Generation” on page 33-83
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
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Code Definition and Mapping Limitations and Considerations
Limitations
• If a data element in a model is unnamed (for example, a signal has no label or a state has no

name), you must specify a code identifier for the data element when configuring it for C code
generation. Set the code identifier by specifying a value for the storage class property Identifier.

• You cannot use code mappings to configure MATLAB variables that are used as block parameters.
Convert the variables to Simulink.Parameter objects in the model workspace. The resulting
data objects appear in the Code Mappings editor as model parameters.

• Use code mappings to configure only one discrete state per block in a model.
• To map these data categories to a storage class defined in an Embedded Coder Dictionary, you

must set the storage class property Data Initialization to Dynamic or None:

• Inport
• Outport
• Signals, states, and internal data
• Shared local data stores

• You cannot map data categories External parameters and Global data stores. For referenced
models you cannot map data, categories Inports and Outports to storage classes that are defined
in an Embedded Coder Dictionary.

• You cannot map categories of data to:

• Predefined structure-based storage classes, Struct and BitField
• Package storage classes of type FlatStructure or Other that you create by using the

Custom Storage Class Designer
• If you configure a model to use a code replacement library that includes a data alignment
specification, you cannot configure default code mappings that involve storage classes defined in
the Embedded Coder Dictionary for that model. For more information, see “Data Alignment for
Code Replacement” on page 67-97.

• If a model contains a tunable, nonfinite parameter, for example, with a value of inf:

• The code generator does not apply a specified default parameter mapping. The parameter
appears as a field in the default parameter data structure rtP (see “Real-Time Model Data
Structure” on page 34-32).

• You cannot map an individual element to a storage class defined in an Embedded Coder
Dictionary. If you do, the code generator returns an error. Choose one of these workarounds:

• For the individual nonfinite parameter, set the storage class to a value other than Auto or
Model default, as described in “Configure Parameters for C Code Generation” on page
33-62.

• If only one block uses the variable or object, instead of using the variable or object, specify
the nonfinite value directly in the model, in the block parameter.

Default Code Mapping Constraints
• Map parameter categories to storage classes that are defined with the Data Initialization

property set to Auto, Static, or None.
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• If a model includes a reusable subsystem (a subsystem that has the block parameter Function
packaging set to Reusable function) that contains a shared local data store, map the
category Shared local data stores to a storage class that is defined in the Embedded Coder
Dictionary for that model. For more information, see “Generate Reentrant Code from Subsystems”
on page 7-33.

• For top and referenced models configured for multi-instance use, map data categories to storage
classes that have the Storage Type property set to Structured. See “Generate Reentrant Code
from Top Models” on page 7-18 and “Generate Reentrant Code from Simulink Function Blocks” on
page 7-23.

• Default code mappings for categories External parameters and Global data stores must be the
same for models throughout the model reference hierarchy.

• When a model is configured for compact file packaging, you cannot map a data category to a
storage class defined with the Data Scope property set to Exported and the Header File
property set to a naming rule other than $N.h.

• When evaluating storage class settings for variant control variables, the code generator ignores
default code mappings. For more information, see “Represent Subsystem and Variant Models in
Generated Code” on page 26-21.

Unresolved Code Definitions
If someone removes the definition for a storage class, function customization template, or memory
section from the Embedded Coder Dictionary associated with a model, the Code Mappings editor
identifies the definition as Unresolved. For example, this figure shows that the function
customization template for execution entry-point functions was removed from the dictionary
associated with the model.

To fix the unresolved code definition, do one of the following:

• Select a different definition in the Storage Classes, Function Customization Templates, or
Memory Sections column.

• If you have Embedded Coder, replace or add a definition to the Embedded Coder Dictionary. Then,
update the mapping.

• Consult with someone, such as the system architect for your project, about adding a definition to
the Embedded Coder Dictionary. Then, update the mapping.

Model Editing Operations and Individual Data Element Code Mappings
While editing a model in the context of a coder app, you should be aware of the relationship between
Simulink model editing tools, such as copy and undo, and code mappings. In the context of a coder
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app, when you perform copy-and-paste or cut-and-paste editing operations within a model, the coder
app preserves the code mappings for individual data elements. For example, within a model, if you
copy and paste the source block of a signal that is configured with a specific storage class, the pasted
version of the signal port retains the same storage class.

While you can use undo and redo operations for editing actions on model data elements, they are
unavailable while configuring code mappings. For example, if you delete a state block, and then click
Undo, the block reappears in the model canvas and the code configuration for the state reappears in
the code mappings. In the Code Mappings editor, if you change the storage class setting for a state
from Auto to Model default, and then click Undo, the storage class does not revert to Auto. In
this case, the change pertains to the code mapping, not to the model data element.

Storage Classes and Reentrant, Multi-Instance Models and
Components
The code that you generate from a model or component (referenced model or subsystem) is multi-
instance code if it allows your application to maintain multiple independent instances of the
component during execution. For example, you can generate reentrant, multi-instance code from an
entire model by setting the model configuration parameter Code interface packaging to Reusable
function. For general information about multi-instance models and components, see “Code Reuse”.

Under some circumstances, applying storage classes can:

• Prevent you from generating multi-instance code.
• Cause some data elements to appear in the generated code as singletons, which means that each

instance of the model or component directly accesses the same shared, global data, creating
dependencies between the instances.

To avoid errors and unexpected generation of single-instance code and singleton data, observe the
guidelines and limitations below.

Directly Applied Storage Classes

When you apply a storage class directly to a data element (see “C Code Generation Configuration for
Model Interface Elements” on page 33-2):

• To generate multi-instance code, you must apply the storage class only to parameter objects,
global data stores, shared local data stores, and root-level I/O.

• The storage class yields only singleton data.

Storage Classes Applied by Default

When you apply a default storage class (see “C Code Generation Configuration for Model Interface
Elements” on page 33-2):

• For these data categories, you can generate only singleton data:

• Model parameters
• External parameters
• Global data stores
• Shared local data stores
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• For Internal data, you can generate only instance-specific data, which means each instance of
the model or component operates on a separate copy of the data. For this category, you must use
the example storage class SignalStruct, which appears after preparing a model for code
generation with the Quick Start tool. Alternatively, you can create and use your own structured
storage class by using an Embedded Coder Dictionary.

For more information, see “What Is Reentrant Code?” and “Choose Storage Class for Controlling Data
Representation in Generated Code”.

Copy Code Mappings When Converting Subsystems to Referenced
Models
You can copy code mappings when you convert a subsystem to a referenced model.

• In the Model Reference Conversion Advisor, select Copy code mappings.
• In the MATLAB command window, use the Simulink.SubSystem.convertToModelReference

function with the comma-separated pair consisting of 'CopyCodeMappings' and true.

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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Configure Default C Code Generation for Categories of Data
Elements and Functions

Reduce the effort of preparing a model for C code generation by specifying default configurations for
categories of data elements and functions across a model. Applying default configurations can save
time and reduce the risk of introducing errors in code, especially for larger models and models from
which you generate multi-instance code.

You must have set up the example environment, as described in “Set Up Example Environment” on
page 33-15.

Set Up Example Environment
1 Copy these external source and header files from matlabroot/toolbox/rtw/rtwdemos to a

writable working folder. These files define and declare the external data type and data that the
generated code uses.

File Description
exDblFloat.h Defines the project data type alias for double,

DBL_FLOAT. Simulink uses the PreLoadFcn
callback specified for the model to parse this
header file and create a corresponding
Simulink.AliasType object.

exInDataMem.c Includes exInDataMem.h and defines
variable ex_input1.

exInDataMem.h Includes exDbFloat.h and declares variable
ex_input1.

exInDataLut.c exInDataLut.c includes exInDataLut.h
and defines variables ex_input2,
ex_input3, and ex_input4.

exInDataLut.h Includes exDbFloat.h and declares
variables ex_input2, ex_input3, and
ex_input4.

exCodeDefs.sldd Data dictionary
rtwdemo_configdefaults.slx Example model.
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2 Open your copy of example model rtwdemo_configdefaults.

3 In the apps gallery, open the Embedded Coder app.

Configure Default Code Generation for Data
This example shows how to use the Code Mappings editor to specify code generation requirements
for model data. The model uses multiple execution rates and is configured for single-instance usage.

This example assumes these code generation requirements for data:

• Use project type definition DBL_FLOAT defined in header file exDblFloat.h.
• Get data element ex_input1 from header file exInDataMem.h. The data is used for computing a

value stored in memory, and then used in an if-else condition of a Switch block.
• Get data elements ex_input2, ex_input3, and ex_input4 from header file exInDataLut.h.

The data is used in lookup tables Table1 and Table2.
• Data imported into the model from header files exInDataMem.h and exInDataLut.h is of type

DBL_FLOAT, a project standard.
• Parameter K1 must be tunable to enable calibration.
• Data store mode defines data that is shared within the model. The Logical Operator block writes to

the data store and a Rate Transition block reads from the data store.
• Data element X represents the delay for the Unit Delay block.
• Store data that is internal to the model, such as delay X, in a section of memory labeled

internalDataMem.
• Export output data declarations to header file exSysOut.h and definitions to exSysOut.c.
• Name variables representing inports and outports in the generated code as specified in this table

so they match variable names in the external header and definition files.

Although the model uses single instances of some data, the example configures default settings to
demonstrate different types of mappings. As you add blocks to the model, new data elements acquire
the default code generation mappings.
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Configure Default Settings for Root Inports

Specify an external header file that declares input data. Three of the four root inports read input from
variables declared in header file exInDataLut.h. Set that header file as the default.

1 Open model rtwdemo_configdefaults. Save a copy to a writable location.
2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Default Code Mappings. This opens the Code

Mappings editor Data Defaults tab and the Property Inspector.
4 In theData Defaults tab, expand Inports and Outports. Then, select Inports.
5 Set the storage class to ImportFromFile.
6 In the Property Inspector, set Header File to exInDataLut.h.

Configure Default Settings for Model Parameters

Configure default settings for model workspace parameters that you want to be tunable.

1 In the Code Mappings editor, click the Data Defaults tab.
2 In theData Defaults tab, expand Parameters.
3 In the row for Model parameters, click the text 'Auto' will be inlined. The Model

Configuration Parameters dialog box opens to the Code Generation > Optimization pane. Set
Default parameter behavior to Tunable. Apply the change and close the dialog box. In the
Code Mappings editor, the text to the right of Model parameters now reads 'Auto' will be
tunable.

4 To include global variable definitions and declarations in the generated code for model
parameters, set the storage class for the Model parameters category to ExportedGlobal.

Define Memory Section for Internal Data

Define a memory section for storing unit delay X, data that is internal to the model.

1 Open the Embedded Coder Dictionary by selecting Code Interface > Embedded Coder
Dictionary.

2 In the Embedded Coder Dictionary, click the Memory Sections tab.
3 Click Add.
4 In the new row of the table, name the new memory section internalDataMem. Also set:

• Pre Statement to #pragma start INTERNALDATA
• Post Statement to #pragma end INTERNALDATA
• Statements Surround to Group of variables

5 Close the dictionary.

For more information, see “Control Data and Function Placement in Memory by Inserting Pragmas”
on page 43-2.

Configure Default Settings for Internal Data

Set up the default code generation configuration for internal data to include memory section
internalDataMem.
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1 In the Code Mappings editor, click the Data Defaults tab.
2 In theData Defaults tab, expand Signals.
3 Select category Signals, states, and internal data.
4 In the Property Inspector, set Memory Section to internalDataMem.

Configure Default Settings for Root Outport

Specify the default external header and definition files for variables to which the generated code
writes output.

1 In the Code Mappings editor, click the Data Defaults tab.
2 In theData Defaults tab, expand Inports and Outports.
3 Select category Outports.
4 Set the storage class to ExportToFile.
5 In the Property Inspector, set Header File to exSysOut.h and Definition File to exSysOut.c.

Apply Default Configurations to Individual Data Elements

Unless you explicitly map individual data elements to alternative storage class settings, the Code
Mappings editor assumes the storage class for elements is Auto. When the storage class for a data
element is Auto, the code generator might eliminate or change the representation of relevant code
for optimization purposes. If optimizations are not possible, the code generator applies the model
default configuration.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class for the individual element to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that data element.

For this example, configure the code generator to apply the default storage class setting to these data
elements:

• Inports In2, In3, and In4
• Outport Out1
• Model parameter K1
• State X

1 In the Code Mappings editor, click the Inports tab.
2 Select the rows for inports In2, In3, and In4. Then, for one of the selected inports, set the

storage class to Model default: ImportFromFile. The storage class for the three selected
inports changes to Model default: ImportFromFile.

3 Click the Outports tab. For outport Out1, set the storage class to Model default:
ExportToFile.

4 Click the Parameters tab. Expand Model Parameters. Then, for parameter K1, set the storage
class to Model default: ExportedGlobal.

5 Click the Signals/States tab. Expand States. For state X, set the storage class to Model
default: Default.

6 Save the model.
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Generate and Verify Code

Generate code and verify the generated code.

• In the file rtwdemo_configdefaults.h, search for #include statements that include the
header files that declare external input data.

#include "exInDataMem.h"
#include "exInDataLut.h"

• Open file rtwdemo_configdefaults.c. The code initializes the gain variable K1 and uses the
variable in the model step function exFast_step1.

DBL_FLOAT K1 = 2.0;
.
.
.
void exFast_step1(void)
{
  DBL_FLOAT rtb_Gain;
  
  rtb_Gain = K1 * look1_binlc(ex_input2, (&(rtTable1_bp01Data[0])),
    (&(rtTable1_tableData[0])), 10U);

  rtDWork.RateTransition_Buffer0 = rtb_Gain;
}
  .
  .
  .
}

• In file rtwdemo_configdefaults.c, find #pragma control lines that define memory sections for
INTERNALDATA (the local data store, unit delay, and constants).

#pragma start INTERNALDATA

D_Work rtDWork;

#pragma end INTERNALDATA
.
.
.
#pragma start INTERNALDATA

static RT_MODEL rtM_;

#pragma end INTERNALDATA
.
.
.
pragma start INTERNALDATA

extern D_Work rtDWork;

#pragma end INTERNALDATA

• Open file exSysOut.c. The file includes an exported data definition for ex_output.

#include "rtwdemo_configdefaults.h"

DBL_FLOAT ex_output;

• Open shared file exSysOut.h. The file declares ex_output. To gain access to ex_output,
external code can include this header file.

extern DBL_FLOAT ex_output;
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Configure Default Code Generation for Functions
This example shows how to use the Code Mappings editor to specify code generation requirements
for model functions. The model uses multiple execution rates and is configured for single-instance
usage. The code generator produces initialize, execution, and terminate entry-point functions.
Because the model uses multiple rates, the code generator produces an execution function for each
rate.

This example assumes these code generation requirements:

• Store generated initialize and terminate functions in memory section functionSlowMem and
execution functions in memory section functionFastMem.

• Use the naming rule exSlow_$N to name initialize and terminate functions. Use the naming
rule exFast_$N to name execution functions.

Define Memory Sections

Define the two memory sections: functionSlowMem for initialize and terminate functions and
functionFastMem for execution functions.

1 Open the Embedded Coder app.
2 Open the Embedded Coder Dictionary by selecting Code Interface > Embedded Coder

Dictionary.
3 In the Embedded Coder Dictionary, click the Memory Sections tab.
4 Click Add.
5 In the new row of the table, name the new memory section functionFastMem. Then, set:

• Pre Statement to #pragma start FASTMEM
• Post Statement to #pragma end FASTMEM

6 Click Add again. Name the memory section functionSlowMem. Then, set:

• Pre Statement to #pragma start SLOWMEM
• Post Statement to #pragma end SLOWMEM

Define Function Customization Templates

To configure categories of functions, define function customization templates. Unless you define
templates in the Embedded Coder Dictionary that are associated with a model, the only available
template is Default. Based on the requirements, in the dictionary, define two function customization
templates: one to specify the naming rule and memory section for initialize and terminate functions
and one to specify the naming rule and memory section for execution functions.

1 In the Embedded Coder Dictionary, click the Function Customization Templates tab.
2 Click Add.
3 In the new row of the table, name the new template exFastFunction. Then, set:

• Function Name to exFast_$N. This naming rule applies the prefix exFast_ to the name
that identifies the default code generator name of the function (for example, initialize or
step).

• Memory Section to functionFastMem. This mapping associates the memory section that
you defined in “Define Memory Sections” on page 33-20 with the new template.
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4 Click Add again. Name the template exSlowFunction. Then, set:

• Function Name to exSlow_$N.
• Memory Section to functionSlowMem.

5 Close the dictionary.

Configure Default Settings for Functions
1 In the C Code tab, click Code Interface > Default Code Mappings.
2 In the Code Mappings editor, click the Function Defaults tab.
3 Configure the initialize and terminate entry-point functions. For category Initialize/Terminate,

select template exSlowFunction.
4 Configure the execution entry-point functions. For category Execution, select template

exFastFunction.
5 Save the model.

Generate and Verify Code
1 Generate code.
2 In the Code view:
3 • Open file rtwdemo_configdefaults.c. Click in the Search field. A menu lists the

generated entry-point functions:

• exFast_step0 (called periodically, every 0.5 seconds)
• exFast_step1 (called periodically, every 1 second)
• exFast_step2 (called periodically, every 1.5 seconds)
• exSlow_initialize

• To gain access to the entry-point function code in rtwdemo_configdefaults.c, click the
function name. Verify the pragma control statements that surround the function code. For
example:
.
.
.
#pragma start FASTMEM

void exFast_step2(void)                /* Sample time: [1.5s, 0.0s] */
{
   boolean_T rtb_DataStoreRead;

   rtb_DataStoreRead = ((ex_input1 > 10.0) || (ex_input1 < -10.0));

   rtDWork.RateTransition1_Buffer0 = rtb_DataStoreRead;
}

#pragma end FASTMEM

#pragma start SLOWMEM

void exSlow_initialize(void)
{
   /* (no initialization code required) */
}

#pragma end SLOWMEM
.
.
.
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• Open file rtwdemo_configdefaults.h. Use Search to find #pragma control lines that
define memory sections for FASTMEM and SLOWMEM. Verify the pragma control statements
surround the declarations. For example:
.
.
.
#pragma start SLOWMEM

extern void exSlow_initialize(void);

#pragma end SLOWMEM
#pragma start FASTMEM

extern void exFast_step0(void);

#pragma end FASTMEM
.
.
.

Configure Model Elements for Code Generation with Definitions Stored
in Shared Data Dictionary
You have the option of configuring default data and function code generation with definitions that are
set up in a Simulink data dictionary. A data dictionary enables sharing of code definitions between
models. This example shows how to change a model from using code definitions in a model-specific
Embedded Coder Dictionary to using definitions in an Embedded Coder Dictionary that is in a shared
data dictionary. If you have completed the examples in “Configure Default Code Generation for Data”
on page 33-16 and “Configure Default Code Generation for Functions” on page 33-20 you have added
these code definitions to the Embedded Coder Dictionary associated with model
rtwdemo_configdefaults.

• Memory section internalDataMem with Pre Statement set to #pragma start INTERNALDATA
and Post Statement set to #pragma end INTERNALDATA.

• Memory section functionFastMem with Pre Statement set to #pragma start FASTMEM and
Post Statement set to #pragma end FASTMEM.

• Memory section functionSlowMem with Pre Statement set to #pragma start SLOWMEM and
Post Statement set to #pragma end SLOWMEM.

• Function customization template exFastFunction with function naming rule exFast_$N and
memory section functionFastMem

• Function customization template exSlowFunction with function naming rule exSlow_$N and
memory section functionSlowMem

Update model rtwdemo_configdefaults to use the same code definitions in data dictionary
exCodeDefs.sldd instead of definitions in the local model Embedded Coder Dictionary.

You must have set up the example environment, as described in “Set Up Example Environment” on
page 33-15.

Link Model to Shared Data Dictionary

1 In the Simulink Editor, select Modeling > Link to Data Dictionary.
2 In the Model Properties dialog box, in the External Data tab, browse to the location of your copy

of data dictionary file exCodeDefs and select that file.
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3 Click Migrate data.
4 In the Link Model to Data Dictionary dialog box, click Apply.
5 In the Migrate Data dialog box, click Migrate. When the data migration is complete, click OK.

Review Contents of Linked Data Dictionary

1 In the lower-left corner of the model canvas, click the Model data icon.
2 From the list of model data sources, click External Data.
3 In the Model Explorer, in the Model Hierarchy pane, expand the exCodeDefs node.
4 Right-click Embedded Coder Dictionary.
5 Click the Open Embedded Coder Dictionary button that appears.
6 In the Embedded Coder Dictionary, review the definitions in the Function Customization

Templates and Memory Sections tabs.
7 Close the Embedded Coder Dictionary.

Remove Model Sourced Code Definitions from Model Embedded Coder Dictionary

1 Open the Embedded Coder app.
2 In the C Code tab, select Code Interface > Embedded Coder Dictionary.
3 Remove the code definitions created locally in the model.

• In the Function Customization Templates tab, select the rows for exSlowFunction and
exFastFunction that have Source set to rtwdemo_configdefaults. Click Remove.

• In the Memory Sections tab, select the rows for functionFastMem, functionSlowMem,
and internalDataMem that have Source set to rtwdemo_configdefaults. Click Remove.

4 Close the dictionary.
5 Save the model.

Configure Default Categories for Code Generation

1 In the C Code tab, select Code Interface > Default Code Mappings.
2 In the Code Mappings editor, click the Data Defaults tab.
3 Expand Signals. Select category Signals, states, and internal data.
4 In the Property Inspector, set Memory Section to internalDataMem.
5 Click the Function Defaults tab.

• For the Initialize/Terminate category, select function customization template
exSlowFunction.

• For the Execution category, select template exFastFunction.
6 Save the model.
7 Generate and review code.

For more information about setting up an Embedded Coder Dictionary, see “Define Storage Classes,
Memory Sections, and Function Templates for Software Architecture” on page 31-2.
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Configure Default Data and Function Code Generation
Programmatically
This example shows how to configure default data and function code generation for example model
rtwdemo_configdefaults.The example uses the default mapping programming interface to specify
code generation requirements for model data and functions. Use that interface to automate the
configuration, or if you prefer to configure models programmatically. For information about
configuring the default data and function code generation by using the Code Mappings editor, see
“Configure Default C Code Generation for Categories of Data Elements and Functions” on page 33-
15.

Open the Model

The model rtwdemo_configdefaults uses multiple execution rates and is configured for single-
instance usage.

open_system('rtwdemo_configdefaults')

Code Generation Requirements

For this example, these are the code generation requirements:

• Import project type definition for data of type double, DBL_FLOAT, from header file
exDblFloat.h.

• Import signal ex_input1 for computing a value stored in memory and used in an if-else condition
in the Switch block. Import the signal data from header file exInDataMem.h.

• Import signals ex_input2, ex_input3, and ex_input4 for lookup tables Table1 and Table2.
Import the signal data from header file exInDataLut.h.

• Data imported into the model from header files exInDataMem.h and exInDataLut.h is of type
DBL_FLOAT, a project standard.
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• Parameters UPPER, LOWER, K1, and K2 are parameter objects stored in the model workspace.
Represent the parameters as global variables in the generated code.

• Data element X represents the delay for the Unit Delay block.
• Store data that is internal to the model in memory section internalDataMem.
• Store generated initialize and terminate functions in memory section functionSlowMem and

execution functions in memory section functionFastMem.
• Use the identifier naming rule exSlow_$N to name initialize and terminate entry-point

functions. Use the naming rule exFast_$N to name execution functions for .5 second and 1.5
second periodic functions. Set the name of the 1 second periodic function to exFast_1sec.

• Export output data declarations to header file exSysOut.h and definitions to exSysOut.c.

For this example, someone, such as a system architect, has previously created these code definitions
in an Embedded Coder Dictionary that is part of Simulink data dictionary exCodeDefs.sldd:

• Memory sections internalDataMem, functionFastMem, and functionSlowMem.
• Function customization templates exFastFunction and exSlowFunction.

Get Data and Function Code Mappings for Model

Get the code mappings for example model rtwdemo_configdefaults by specifying the name of the
model in a call to function coder.mapping.api.get. The function returns an object that represents
the code mappings for the model. You specify that object as the first argument in subsequent calls to
other functions in the API.

If code mappings do not exist for a model, create a code mappings object by calling
coder.mapping.utils.create.

cm = coder.mapping.api.get('rtwdemo_configdefaults');

Set Relevant Category, Property, and Value Combinations

Set relevant category, property, and value combinations with calls to setDataDefaults and
setFunctionDefaults. The first two arguments that you specify for these functions are the code
mappings object returned by coder.mapping.api.get and the name of a data or function category.
In addition, you specify name-value pair arguments that specify the default configuration information
that you want to set, such as the storage class and storage class properties.

In this example, you set the default:

• Storage class for Inport blocks, Outport blocks, and model parameters
• Memory section for internal data (for example, signald and block states)
• Header and definition files for Inport and Outport blocks
• Function customization template for initialize, terminate, and execution functions

% Configure data defaults
setDataDefault(cm,'Inports','StorageClass','ImportFromFile','HeaderFile','exInDataLut.h');
setDataDefault(cm,'Outports','StorageClass','ExportToFile','HeaderFile','exSysOut.h',...
    'DefinitionFile','exSysOut.c');
setDataDefault(cm,'ModelParameters','StorageClass','ExportedGlobal');
setDataDefault(cm,'InternalData','MemorySection','internalDataMem');

% Configure function defaults
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setFunctionDefault(cm,'InitializeTerminate','FunctionCustomizationTemplate','exSlowFunction');
setFunctionDefault(cm,'Execution','FunctionCustomizationTemplate','exFastFunction');

Verify Default Mappings

Verify default mappings with calls to getDataDefaults and getFunctionDefaults. The first two
arguments that you specify for these functions are the code mappings object returned by
coder.mapping.api.get and the name of a data or function category. In addition, you specify the
name of the configuration information that you want the function to return, such as the name of the
storage class or a storage class property.

In this example, you verify these default settings:

• Storage class for Inport blocks, Outport blocks, and model parameters
• Memory section for internal data (for example, signal data and block states)
• Header and definition files for Inport and Outport blocks
• Function customization template for initialize, terminate, and execution functions

% Verify default data configurations
defscInports = getDataDefault(cm,'Inports','StorageClass')

defscInports = 
'ImportFromFile'

defhfileInports = getDataDefault(cm,'Inports','HeaderFile')

defhfileInports = 
'exInDataLut.h'

defscOutport = getDataDefault(cm,'Outports','StorageClass')

defscOutport = 
'ExportToFile'

defhfileOutport = getDataDefault(cm,'Outports','HeaderFile')

defhfileOutport = 
'exSysOut.h'

defdffileOutport = getDataDefault(cm,'Outports','DefinitionFile')

defdffileOutport = 
'exSysOut.c'

defscParams = getDataDefault(cm,'ModelParameters','StorageClass')

defscParams = 
'ExportedGlobal'

defmemInternal = getDataDefault(cm,'InternalData','MemorySection')

defmemInternal = 
'internalDataMem'

% Verify default function configurations
deftempInitTerm = getFunctionDefault(cm,'InitializeTerminate','FunctionCustomizationTemplate')
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deftempInitTerm = 
'exSlowFunction'

deftempExecution = getFunctionDefault(cm,'Execution','FunctionCustomizationTemplate')

deftempExecution = 
'exFastFunction'

Configure Individual Data Elements to Use Default Configuration Settings

The storage class for each model data element is set to Auto, which means that the code generator
might eliminate or change the representation of relevant code for optimization purposes. If
optimizations are not possible, the code generator applies the model default configuration.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that inport.

For this example, you configure the code generator to apply the default storage class setting to the
Inport blocks, the Output block, model parameters, and state X for the Unit Delay block. Use the
find function to get the names of the data elements in the model of the different categories. Then,
use the values returned by find in calls to setInport, setOutport, setModelParameter, and
setState to set the storage class to Model default. Use calls to getInport, getOutport,
getModelParameter, and getState to verify, the storage class settings.

In each of the function calls, you specify the code mappings object returned by
coder.mapping.api.get. In addition:

• In the call to the find function, you specify a value indicating code mapping information that you
want the function to return.

• The calls to setInport, setOutport, setModelParameter, and setState identify data
elements that you want to configure and a name-value pair argument that specifies the
configuration information that you want to set, such as the storage class or a storage class
property.

• The calls to getInport, getOutport, getModelParameter, and getState identify a data
element for which you want to return configuration information and the type of information that
you want the function to return.

input = find(cm,'Inports');
setInport(cm,input,'StorageClass','Model default');

output = find(cm,'Outports');
setOutport(cm,output,'StorageClass','Model default');

params = find(cm,'ModelParameters');
setModelParameter(cm,params,'StorageClass','Model default');

states = find(cm,'States');
setState(cm,states,'StorageClass','Model default');

scIn1 = getInport(cm,'In1','StorageClass')

scIn1 = 
'Model default'
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scIn2 = getInport(cm,'In2','StorageClass')

scIn2 = 
'Model default'

scIn3 = getInport(cm,'In3','StorageClass')

scIn3 = 
'Model default'

scIn4 = getInport(cm,'In4','StorageClass')

scIn4 = 
'Model default'

scK1 = getModelParameter(cm,'K1','StorageClass')

scK1 = 
'Model default'

scTable2 = getModelParameter(cm,'Table2','StorageClass')

scTable2 = 
'Model default'

scK2 = getModelParameter(cm,'K2','StorageClass')

scK2 = 
'Model default'

scX = getState(cm,'rtwdemo_configdefaults/Delay','StorageClass')

scX = 
'Model default'

Override Default Header File Setting for Inport Block In1

Previously, you set the default header file for inports to exInDataLut.h. The requirements specify
that you import data for Inport block In1 from header file exInDataMem.h.

For Inport block In1, override the default storage class to ImportFromFile and set the header file
to exInDataMem.h with a call to setInport. The function call specifies the code mappings object
returned by coder.mapping.api.get, the name of the Inport block to configure, and name-value
pair arguments specifying that the function set StorageClass to ImportFromFile and
HeaderFile to exInDataMem.h.

setInport(cm,'In1','StorageClass','ImportFromFile','HeaderFile','exInDataMem.h');

Verify Header File Setting

Verify the updated header file setting for Inport block In1 with a call to getInport.The function call
specifies the code mappings object returned by coder.mapping.api.get, the name of the Inport
block of interest, and the configuration information to return.

hfileIn1 = getInport(cm,'In1','StorageClass')

hfileIn1 = 
'ImportFromFile'
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Override Default Function Name Setting for Step Function

Previously, you set the default function customization template for exeuction functions to
functionFastMem, which applies the naming rule exFast_$N to the three step functions
generated for the model. The requirements specify that the name for function Periodic:D2, which
has a sample time of 1 seccond, be named exFast_1sec.

Set the function name with a call to setFunction.The function call specifies the code mappings
object returned by coder.mapping.api.get, the source of the function, Periodic:D2, and the name-
value pair argument specifying that the function set the function name to exFast_1sec.

setFunction(cm,'Periodic:D2','FunctionName','exFast_1sec')

Verify Function Name Setting

Verify the updated function name setting for execution function Periodic:D2 with a call to
getFunction.The function call specifies the code mappings object returned by
coder.mapping.api.get, the function of interest, and property FunctionName.

functionName = getFunction(cm,'Periodic:D2','FunctionName')

functionName = 
'exFast_1sec'

Related Links

• “Configure Root-Level Outport Blocks for C Code Generation” on page 33-42
• “Configure Root-Level Outport Blocks for C Code Generation” on page 33-42
• “Configure Signal Data for C Code Generation” on page 33-51
• “Configure Parameters for C Code Generation” on page 33-62
• “Configure Block States for C Code Generation” on page 33-75
• “Configure Data Stores for C Code Generation” on page 33-83
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• Code Mappings Editor – C
• Embedded Coder Dictionary

See Also

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Choose Data Configuration Approach” on page 34-69
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Generate Code to Conform to Software Architecture by Sharing and Copying Default Settings

Between Models” on page 31-18
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Configure Root-Level Inport Blocks for C Code Generation
To use code that you generate from a model, you call generated entry-point functions. The calling
environment and generated functions exchange input and output data, for example, as global
variables or function arguments. Root-level Inport blocks (inports) constitute the input data of the
interface. To integrate and deploy the generated code into applications, you can customize how the
code generator produces the interface code, including how input data is declared and handled.
Customizations can:

• Minimize the modifications that you must make to existing code.
• Generate stable interfaces that do not change or minimally change when you make changes to

your model.
• Generate code that exchanges data more efficiently (for example, by using pointers and pass-by-

reference arguments for nonscalar data).

Enable and Trigger blocks (function-call inports) also load data into a system from outside the
system. From a code generation perspective, these modeling elements are exported functions. For an
exported function, the code generator produces an entry-point function, which you can configure. See
“Configure C Code Generation for Model Entry-Point Functions” on page 33-112.

For code generation, examples show how to customize the inport interface for model
rtwdemo_configinterface . You can configure code mappings by using the Code Mappings
editor or code mappings API (coder.mapping.api.CodeMapping).

Choose Customization Options for Inport Interface
By default, root-level inports in a model appear in generated code as fields of a global data structure
named model_ExtU. Based on your code interface requirements, decide whether to customize
generation of root-level inport data. If you do not configure customizations, the code generator
determines whether to eliminate or change the representation of inports in generated code for
optimization purposes. If you configure customizations, decide:

• Whether to set up a default configuration

If a model includes a significant number (for example, more than 10) of root-level inports, it is
more efficient to configure the inports with a default setting, and then override that setting for
special cases. If the model includes a few root-level inports that have unique source, naming, or
placement requirements, consider configuring the inports individually.

• How to declare and handle root-level inport data in the generated interface

• As separate global variables
• To read input data from global variables defined in external code
• For referenced model inports, as global variables (void-void)
• As calls to access functions. Requires Embedded Coder
• As entry-point function arguments. Requires Embedded Coder

For more information about these options, see “Control Data and Function Interface in Generated
Code” on page 34-44.

Other considerations include whether to:
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• Name inports in the generated code by using Inport block labels that appear in the model or by
using unique code identifiers.

• Include the volatile type qualifier in global variable definitions and declarations. Requires
Embedded Coder. See “Protect Global Data with const and volatile Type Qualifiers” on page 43-
13.

• Place data read into a specific area of memory. Requires Embedded Coder. See “Control Data and
Function Placement in Memory by Inserting Pragmas” on page 43-2.

For a list of interface requirements that are relevant to inports with corresponding storage classes
and storage class properties, see “Choose Storage Class for Controlling Data Representation in
Generated Code” on page 34-74.

For example model rtwdemo_configinterface, inport interface requirements are:

• Use project type definition DBL_FLOAT defined in header file exDblFloat.h.
• Get data for inport In1 from header file exInDataMem.h. The data is used for computing a value

that is stored in memory, and then used in an if-else condition of code generated for the Switch
block.

• Get data elements for inports In2, In3, and In4 from header file exInDataLut.h. The data is
used in lookup tables Table1 and Table2.

• Variables representing the inports in the generated code must be named input1, input2,
input3, and input4.

For this example, configure inports in rtwdemo_configinterface to meet these code generation
requirements.

Configure Default Code Generation Settings for Root-Level Inports
A default code generation setting for root-level inports can reduce the effort of preparing a model for
code generation, especially if a model has a significant number of inports. Choose configuration
settings once, and the code generator applies those settings to the inports across the model. Simulink
stores the default configuration as part of the model.

Consider configuring default code generation settings for model root-level inports if your model uses
multiple root-level inports that do not have unique requirements or uses a shared Embedded Coder
Dictionary.

This example shows how to use the Code Mappings editor to configure default settings for root-
level inports for model rtwdemo_configinterface. Specify an external header file that declares input
data. Three of the four root inports read input from variables declared in header file
exInDataLut.h. Set that header file as the default input source for inports.

1 Open example model rtwdemo_configinterface. Save a copy of the model to a writable
location.
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2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Default Code Mappings.
4 In the Code Mappings editor, under Inports and Outports, select category Inports. Set the

default storage class to ImportFromFile.
5 In the Property Inspector, set Header File to exInDataLut.h.

33 Configuring Data and Functions in the Generated Code

33-32



6 Save the model.

Configure Code Generation Settings for Individual Root-Level Inports
You can configure individual root-level inports for code generation. For example, if a model has two
root-level inports that have unique code generation requirements, configure the inports individually.
Or, if you configure default settings for inports, configure individual inports to use the default settings
or unique settings.

If your model meets at least one of these criteria, consider configuring code generation settings for
root-level inports individually:

• Uses multiple inports that have unique requirements.
• Uses few inports.
• Has a default configuration for inports and you need to override the configuration for some
specific inports.

This example shows how to use the Code Mappings editor to override the default code generation
configuration for one of the inports in model rtwdemo_configinterface. In the preceding
example, you set the default storage class for inports to ImportFromFile. The model requires that
inport In1 read input data from a global variable instead of a global variable pointer.
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The example also shows how to configure identifiers that the code generator uses for naming the four
inports in the generated code. You can specify code generation identifiers, for example for
integration, without having to modify the model design.

1 If you have not already done so, complete the steps in “Configure Default Code Generation
Settings for Root-Level Inports” on page 33-31.

2 In the Code Mappings editor, click the Inports tab. The editor lists the names of Inport blocks
and bus elements that are in the model. If a port resolves to a signal object, a resolve-to-signal-
object icon appears to the right of the element name. The storage class for each inport is set to
Auto, which means that the code generator might eliminate or change the representation of
relevant code for optimization purposes. If optimizations are not possible, the code generator
applies the model default configuration. For this example, the model default configuration
specifies storage class ImportedFromFile.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that inport.

3 Configure the code generator to apply the default storage class setting to inports In2, In3, and
In4. Select the rows for the three inports. Then, for one of the selected inports, set the storage
class to Model default: ImportFromFile.

The storage class for the three selected inports changes to Model default:
ImportFromFile.

4 For inport In1, override the default storage class setting. Set the storage class to
ImportFromFile. In the Property Inspector, set Header File to exInDataMem.h.
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5 Configure code identifiers for the inports so that the interface argument names in the generated
code match the interface names in the external header and definition files. In the Code Mappings
editor, select the row for each inport. In the Property Inspector, set the Identifier property to
these values.

Inport Code Identifier
In1 input1
In2 input2
In3 input3
In4 input4

6 Save the model.
7 Generate and view the code. For example, in rtwdemo_configinterface.c find where

variables input1, input2, input3, and input4 are used in the step entry-point function.
void rtwdemo_configinterface_step(void)
{
  mode = ((input1 > rtwdemo_configinterface_UPPER) || (input1 <
           rtwdemo_configinterface_LOWER));

  dout_Table1 = look1_binlc(input2, ((const MYTYPE *)&(Table1.BP[0])), ((
    const MYTYPE *)&(Table1.Table[0])), 10U);
.
.
.
  dout_Table2 = look2_binlc(input3, input4, ((const MYTYPE *)&(mp_Table2.BP1[0])),
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    ((const MYTYPE *)&(mp_Table2.BP2[0])), ((const MYTYPE *)&(mp_Table2.Table[0])),
    ((const uint32_T *)&(rtwdemo_configi_Table2_maxIndex[0])), 3U);

  dstate_X = dout_Table2;
}

Configure Code Generation Settings for Root-Level Inports
Programmatically
To automate configuration of root-level inports for code generation, use the programming interface
for code mappings. For example, when creating custom block libraries or part of an application test
environment, use the programming interface to automate data configuration.

This example shows how to use the programming interface to configure default settings for root-level
inports for model rtwdemo_configinterface. Specify an external header file that declares input data.
Three of the four root-level inports read input from variables declared in header file exInDataLut.h.
You set that file as the default header file. Then, you override the default code generation
configuration for In1, which requires that input data be read from header file exInDataMem.h.

In addition, you configure code identifiers for the inports so that global variable names in the
generated code match the variable names defined in an external file.

1 Open the example model.

open_system('rtwdemo_configinterface')
2 Create object cm by calling function coder.mapping.api.get. The object stores the data and

function code generation configuration for model rtwdemo_configinterface.

cm = coder.mapping.api.get('rtwdemo_configinterface');
3 Configure default settings for inports by calling function setDataDefault. For the arguments,

specify these values:

• The object returned by coder.mapping.api.get
• Inports for the default category
• Property name StorageClass with property value ImportFromFile
• Property name HeaderFile with property value exInDataLut.h, the name of the external
file that contains the input data

setDataDefault(cm,'Inports','StorageClass','ImportFromFile','HeaderFile','exInDataLut.h')

4 Verify your default configuration for inports. Issue two calls to getDataDefault that specify the
object returned by coder.mapping.api.get and category Inports. In the first call, specify
the third argument as property StorageClass. In the second call, for the third argument,
specify HeaderFile.

getDataDefault(cm,'Inports','StorageClass')

ans =

    'ImportFromFile'

getDataDefault(cm,'Inports','HeaderFile')

ans =

    'exInDataLut.h'
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5 Override the default inport configuration for inport In1. The requirements for that inport differ
from requirements of the other three inports.

By default, Simulink sets the storage class for individual inports to Auto. When the storage class
is Auto, the code generator:

• Determines whether to eliminate the data from the generated code for optimization purposes.
• If retaining the data, determines how to efficiently represent the data in the generated code,

taking into account default configuration settings.

To control the storage class and header file configuration for an inport, configure settings for the
inport with function setInport. Configure code generated for inport In1 to read input data
from global variables defined in external header file exInDataMem.h, as specified in the
requirements. Issue two calls to function setInport that specify the object returned by
coder.mapping.api.get and Inport block named In1. In the first call, also specify property
name StorageClass and property value ImportFromFile. In the second call, specify property
name HeaderFile and property value exInDataMem.h.

setInport(cm,'In1','StorageClass','ImportFromFile')
setInport(cm,'In1','HeaderFile','exInDataMem.h')

6 Verify your configuration for inport In1 by calling function getInport.

getInport(cm,'In1','StorageClass')

ans =

    'ImportFromFile'

getInport(cm,'In1','HeaderFile')

ans =

    'exInDataMem.h'
7 Configure the code generator to apply your default inport settings to inports In2, In3, and In4.

For each inport, call function setInport. Specify the object returned by
coder.mapping.api.get, the Inport block name, property name StorageClass, and property
value Model default.

setInport(cm,'In2','StorageClass','Model default')
setInport(cm,'In3','StorageClass','Model default')
setInport(cm,'In4','StorageClass','Model default')

8 Verify your configuration changes for inports In2, In3, and In4 with calls to function
getInport.

getInport(cm,'In2','StorageClass')

ans =

    'Model default'

getInport(cm,'In3','StorageClass')

ans =

    'Model default'
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getInport(cm,'In4','StorageClass')

ans =

    'Model default'
9 Configure code identifiers for the inports so that the global variables that represent inports in the

generated code match the variable names in the external definition file. For each inport, call
function setInport. Specify the object returned by coder.mapping.api.get, the Inport block
name, property name Identifier, and one of these property values.

Inport Code Identifier
In1 input1
In2 input2
In3 input3
In4 input4

setInport(cm,'In1','Identifier','input1');
setInport(cm,'In2','Identifier','input2');
setInport(cm,'In3','Identifier','input3');
setInport(cm,'In4','Identifier','input4');

10 Verify your configuration changes for the inports by using calls to function getInport.

getInport(cm,'In1','Identifier')

ans =

    'input1'

getInport(cm,'In2','Identifier')

ans =

    'input2'

getInport(cm,'In3','Identifier')

ans =

    'input3'

getInport(cm,'In4','Identifier')

ans =

    'input4'
11 Save the model.
12 Generate and view the code. For example, in rtwdemo_configinterface.c find where

variables input1, input2, input3, and input4 are used in the step entry-point function.
void rtwdemo_configinterface_step(void)
{
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  mode = ((input1 > rtwdemo_configinterface_UPPER) || (input1 <
           rtwdemo_configinterface_LOWER));

  dout_Table1 = look1_binlc(input2, ((const MYTYPE *)&(Table1.BP[0])), ((
    const MYTYPE *)&(Table1.Table[0])), 10U);
.
.
.
  dout_Table2 = look2_binlc(input3, input4, ((const MYTYPE *)&(mp_Table2.BP1[0])),
    ((const MYTYPE *)&(mp_Table2.BP2[0])), ((const MYTYPE *)&(mp_Table2.Table[0])),
    ((const uint32_T *)&(rtwdemo_configi_Table2_maxIndex[0])), 3U);

  dstate_X = dout_Table2;
}

Choose Storage Class and Storage Class Properties for Root-Level
Inports
Depending on your code generation requirements, choose from these storage classes to configure
code generation for root-level inports.

Requirements Storage Class
Enable optimizations, potentially generating more efficient
code.

“Auto” on page 34-76 (Individual
mappings only)

For data elements that cannot be optimized, represent data
as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping only)

Prevent optimizations from eliminating storage for a data
element and use the default mapping for the data element
category.

“Model Default” on page 34-76
(Individual mappings only) ,
Dictionary Default (Individual
mappings only)

Generate a structure that stores Boolean data in named
bitfields.

“Bitfield” on page 34-77 (Individual
mappings only)

Generate a global variable definition and declaration that
have the volatile type qualifier.

Volatile (See “Const, Volatile, and
ConstVolatile” on page 34-78)

Generate a global variable definition and declaration. “ExportedGlobal” on page 34-77
Generate a global variable definition and declaration to a
specified file.

“ExportToFile” on page 34-79

Generate code that interacts with data by calling your
custom accessor functions.

“GetSet” on page 34-80

Generate code that reads from and writes to a global
variable or global variable pointer defined by your external
code.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

Read input data for the inport from a specified external
header file.

“ImportFromFile” on page 34-80

Generate variables that are local to functions. “Localizable” on page 34-81
Generate a global structure that has a name, which you can
specify.

“Struct” on page 34-82 (Individual
mappings only)

The list of available storage classes might include other project-specific storage classes defined in an
Embedded Coder Dictionary. If you have special requirements that are not met by the listed storage
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classes and you have Embedded Coder software, you can define a storage class. See “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2.

For an individual inport, use the Identifier storage class property to configure a name for the
variable representing the inport in the generated code. With Embedded Coder, depending on the
storage class that you choose, you can also configure these properties.

Property Description Storage Classes
DefinitionFile Source definition file that contains

definitions for global data, which is read
by the inport and external code

ExportToFile and
Volatile

GetFunction Inport appears in the generated code as a
call to a specified get function

GetSet

HeaderFile Source header file that contains
declarations for global data that is read by
the inport and external code

ExportToFile, GetSet,
ImportFromFile, and
Volatile

Memory Section
(default inport
configuration only)

Memory section that contains data read by
the inport

Default

Owner Code generator places the definition for
inports in the code generated for one of
multiple models in a model hierarchy that
share definitions. You must select the
model configuration parameter Use
owner from data object for data
definition placement. See “Control
Placement of Global Data Definitions and
Declarations in Generated Files” on page
35-2.

ExportToFile and
Volatile

PreserveDimensions Code generator preserves dimensions of
inport data that is represented in
generated code as a multidimensional
array. You must set model configuration
parameter Array layout to Row-major.
See “Preserve Dimensions of
Multidimensional Arrays in Generated
Code” on page 45-2.

ExportToFile,
ImportFromFile,
Localizable, and Volatile

SetFunction Inport appears in the generated code as a
call to a specified set function.

GetSet

StructName Name for a structure in the generated
code for inport.

BitField and Struct

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “Control Data and Function Interface in Generated Code” on page 34-44
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Configure Root-Level Outport Blocks for C Code Generation
To use code that you generate from a model, you call generated entry-point functions. The calling
environment and generated functions exchange input and output data, for example, as global
variables or function arguments. Root-level Outport blocks (outports) constitute the output data of
the interface. To integrate and deploy the generated code into larger applications, you can customize
how the code generator produces the interface code, including how output data is declared and
handled. Customizations can:

• Minimize the modifications that you make to existing code.
• Generate stable interfaces that do not change or minimally change when you make changes to

your model.
• Generate code that exchanges data more efficiently (for example, by using pointers and pass-by-

reference arguments for nonscalar data).

For code generation, examples show how to customize the outport interface for the model
rtwdemo_configinterface. You can configure code mappings by using the Code Mappings
editor or code mappings API (coder.mapping.api.CodeMapping).

Choose Customization Options for Outport Interface
By default, root-level outports in a model appear in generated code as fields of a global data structure
named model_ExtY. Based on your code interface requirements, decide whether to customize
generation of outport data. If you do not configure customizations, the code generator determines
whether to eliminate or change the representation of outports in generated code for optimization
purposes. If you configure customizations, decide:

• Whether to set up a default configuration

If a model includes a significant number (for example, more than 10) of root-level outports, it is
more efficient to configure the outports with a default setting, and override that setting for special
cases. If the model includes a few outports that have unique source, naming, or placement
requirements, consider configuring the outports individually.

• How to declare and handle outport data in the generated interface

• As separate global variables
• To write output data to global variables defined in external code
• For referenced model outports, as global variables (void-void)
• As calls to access functions. Requires Embedded Coder
• As entry-point function arguments. Requires Embedded Coder

For more information about these options, see “Control Data and Function Interface in Generated
Code” on page 34-44.

Other considerations include whether to:

• Name outports in the generated code by using Outport block labels that appear in the model or by
using unique code identifiers.

• Include the volatile type qualifier in global variable definitions and declarations. Requires
Embedded Coder. See “Protect Global Data with const and volatile Type Qualifiers” on page 43-
13.
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• Write data from a specific area of memory. Requires Embedded Coder. See “Control Data and
Function Placement in Memory by Inserting Pragmas” on page 43-2.

For a list of lists interface requirements that are relevant to outports with corresponding storage
classes and storage class properties, see “Choose Storage Class for Controlling Data Representation
in Generated Code” on page 34-74.

Outport interface requirements for example model rtwdemo_configinterface are:

• Use project type definition MYTYPE defined in rtwdemo_configinterface_data.m.
• Declare a variable for outport Out1 in generated external header file exOutSys.h and define the

variable in source definition file exOutSys.c. The data written to Out1 is the output of code
generated for the Switch block.

• The variable representing the outport in the generated code must be named output1. That name
is the variable name that the external code interface uses to access the output data.

For this example, configure the outport in rtwdemo_configinterface to meet these code
generation requirements.

Configure Default Code Generation Settings for Root-Level Outports
A default code generation setting for root-level outports can reduce the effort of preparing a model
for code generation, especially if a model has a significant number of outports. Choose configuration
settings once, and the code generator applies those settings to outports across the model. Simulink
stores the default configuration as part of the model.

Consider configuring default code generation settings for model outports if your model uses multiple
root-level outports that do not have unique requirements or uses a shared Embedded Coder
Dictionary.

The example model rtwdemo_configinterface includes one root-level outport. This example shows
how to use the Code Mappings editor to configure default settings for root-level outports. Specify
that the code generator declare and define variables to represent root outports in generated external
header and definition files. Name the generated default external header file exOutSys.h and the
generated definition file exOutSys.c.

1 Open example model rtwdemo_configinterface. Save a copy of the model to a writable
location.
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2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Default Code Mappings.
4 In the Code Mappings editor, under Inports and Outports, select category Outports. Set the

default storage class to ExportToFile.
5 In the Property Inspector, set Header File to exOutSys.h and Definition File to exOutSys.c.
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6 Save the model.

Configure Code Generation Settings for Individual Root-Level Outports
You can configure individual root-level outports for code generation. For example, if a model has two
root-level outports that have unique code generation requirements, configure the outports
individually. Or, if you configure default settings for outports, configure individual outports to use the
default settings or unique settings.

If your model meets at least one of these criteria, consider configuring code generation settings for
outports individually:

• Uses multiple outports that have unique requirements.
• Uses few outports.
• Has a default configuration for outports and you need to override the configuration for some
specific outports.

This example shows how to use the Code Mappings editor to apply the default code generation
configuration for outports in model rtwdemo_configinterface. In the preceding example, you set
the default storage class for outports to ExportToFile. A requirement specifies that outport Out1
write output data to a global variable declared and defined in generated header and definition files
accessible to external code.
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The example also shows how to configure an identifier that the code generator uses for naming the
outport in the generated code. You can specify code generation identifiers, for example for
integration, without modifying the model design.

1 If you have not already done so, complete the steps in “Configure Default Code Generation
Settings for Root-Level Outports” on page 33-43.

2 In the Code Mappings editor, click the Outports tab. The editor lists the names of Outport blocks
and bus elements that are in the model. If a port resolves to a signal object, a resolve-to-signal-
object icon appears to the right of the element name. The storage class for the outport in the
example model is set to Auto, which means that the code generator might eliminate or change
the representation of relevant code for optimization purposes. If optimizations are not possible,
the code generator applies the model default configuration. For this example, the model default
configuration specifies storage class ExportToFile.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that outport.

3 Configure the code generator to apply the default storage class setting to outport Out1. Select
the row for the outport. Set the storage class to Model default: ExportToFile.

The storage class for the selected outport changes to Model default: ExportToFile.
4 Configure the code identifier for the outport so that the interface argument name in the

generated code matches the interface name used by the external code. In the Code Mappings
editor, select the row for the outport. In the Property Inspector, set the Identifier property to
output.

5 Save the model.
6 Generate and view the code. For example, in the file rtwdemo_configinterface.c, find where

variable output is used in the step entry-point function.
if (mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
  }
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Configure Code Generation Settings for Root-Level Outports
Programmatically
To automate configuration of root-level outports for code generation, use the programming interface
for code mappings. For example, when creating custom block libraries or part of an application test
environment, use the programming interface to automate data configuration.

This example shows how to use the programming interface to configure default settings for root-level
outports for model rtwdemo_configinterface.

Configure code an identifier for the outport so that global variable name in the generated code
matches the variable name in the external code interface.

1 Open the example model.

open_system('rtwdemo_configinterface')
2 Create object cm by calling function coder.mapping.api.get. The object stores the code

generation configuration for data elements and functions in model
rtwdemo_configinterface.

cm = coder.mapping.api.get('rtwdemo_configinterface');
3 Configure default settings for outports by calling function setDataDefault. For the arguments,

specify these values.

• The object returned by coder.mapping.api.get
• Outports for the default category
• Property name StorageClass that has property value ExportToFile
• Property name HeaderFile that has property value exOutSys.h and property name

DefinitionFile that has property value exOutSys.c, the names for the generated files
that declare and define the output data

setDataDefault(cm,'Outports','StorageClass','ExportToFile','HeaderFile','exOutSys.h',...
'DefinitionFile','exOutSys.c')

4 Verify your default configuration for outports. Issue three calls to getDataDefault that specify
the object returned by coder.mapping.api.get and category Outports.

• In the first call, specify the third argument as property StorageClass.
• In the second call, for the third argument, specify HeaderFile.
• In the third call, for the third argument, specify DefinitionFile.

getDataDefault(cm,'Outports','StorageClass')

ans =

    'ExportToFile'

getDataDefault(cm,'Outports','HeaderFile')

ans =

    'exOutSys.h'

getDataDefault(cm,'Outports','DefinitionFile')
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ans =

    'exOutSys.c'
5 Apply the default outport configuration for outport Out1.

By default, Simulink sets the storage class for individual outports to Auto. When the storage
class is Auto, the code generator:

• Determines whether to eliminate the data from the generated code for optimization purposes.
• If retaining the data, determines how to efficiently represent the data in the generated code,

taking into account default configuration settings.

To control the configuration for an outport, call function setOutport.

Issue a call to setOutport that specifies:

• Object returned by coder.mapping.api.get
• Outport block name Out1
• Default storage class previously set for the outport by using property StorageClass and

property value Model default
• Property Identifier and property value output
setOutport(cm,'Out1','StorageClass','Model default','Identifier','output');

6 Verify your configuration changes by calling function getOutport. Specify the object returned
by coder.mapping.api.get, name of the outport block, and property StorageClass or
Identifier.

getOutport(cm,'Out1','StorageClass')

ans =

    'Model default'

getOutport(cm,'Out1','Identifier')

ans =

    'output'
7 Save the model.
8 Generate and view the code. For example, in the file rtwdemo_configinterface.c, find where

variable output is used in the step entry-point function.
if (mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
  }

Choose Storage Class and Storage Class Properties for Root-Level
Outports
Depending on your code generation requirements, choose from these storage classes to configure
code generation for root-level outports.
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Requirements Storage Class
Enable optimizations, potentially generating more efficient
code.

“Auto” on page 34-76 (Individual
mappings only)

For data elements that cannot be optimized, represent data
as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping only)

Prevent optimizations from eliminating storage for a data
element and use the default mapping for the data element
category.

“Model Default” on page 34-76
(Individual mappings only) ,
Dictionary Default (Individual
mappings only)

Generate a structure that stores Boolean data in named
bitfields.

“Bitfield” on page 34-77 (Individual
mappings only)

Generate a global variable definition and declaration that
has the volatile type qualifier.

Volatile (See “Const, Volatile, and
ConstVolatile” on page 34-78)

Generate a global variable definition and declaration. “ExportedGlobal” on page 34-77
Generate a global variable definition and declaration to a
specified file.

“ExportToFile” on page 34-79

Generate code that interacts with data by calling your
custom accessor functions.

“GetSet” on page 34-80

Generate code that reads from and writes to a global
variable or global variable pointer defined by your external
code.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

Generate code that reads from and writes to a global
variable defined by your external header file.

“ImportFromFile” on page 34-80

Generate variables that are local to functions. “Localizable” on page 34-81
Generate a global structure that has a name, which you can
specify.

“Struct” on page 34-82 (Individual
mappings only)

The list of available storage classes might include other project-specific storage classes defined in an
Embedded Coder Dictionary. If you have special requirements that are not met by the listed storage
classes and you have Embedded Coder software, you can define a storage class. See “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2.

For an individual outport, use the Identifier storage class property to configure a name for the
variable representing the outport in the generated code. With Embedded Coder, depending on the
storage class that you choose, you can also configure these properties.

Property Description Storage Classes
DefinitionFile Source definition file that contains

definitions for global data, which is read
by the outport and external code

ExportToFile and
Volatile

GetFunction Outport appears in the generated code as
a call to a specified get function

GetSet

HeaderFile Name of generated source header file that
contains declarations for global data,
which is written by the outport and
external code

ExportToFile, GetSet,
ImportFromFile, and
Volatile
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Property Description Storage Classes
Memory Section
(default outport
configuration only)

Memory section that contains data written
by the outport

Default

Owner Code generator places the definition for
outports in the code generated for one of
multiple models in a model hierarchy that
share definitions. You must select the
model configuration parameter Use
owner from data object for data
definition placement. See “Control
Placement of Global Data Definitions and
Declarations in Generated Files” on page
35-2.

ExportToFile and
Volatile

PreserveDimensions Code generator preserves dimensions of
outport data that is represented in
generated code as a multidimensional
array. You must set model configuration
parameter Array layout to Row-major.
See “Preserve Dimensions of
Multidimensional Arrays in Generated
Code” on page 45-2.

ExportToFile,
ImportFromFile,
Localizable, and Volatile

SetFunction Outport appears in the generated code as
a call to a specified set function.

GetSet

StructName Name for a structure in the generated
code for outport.

BitField and Struct

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “Control Data and Function Interface in Generated Code” on page 34-44
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Configure Signal Data for C Code Generation
Signal data consists of variables that store intermediate results in global memory as generated
algorithmic code computes values of block output signals from block input signals, excluding signals
that connect to root Inport and Outport blocks. Signal data is not signal lines in a model diagram. For
example, in these cases, a signal line has no data representation in generated code:

• Feeds a function-call port
• Exits a message block, such as the Send block
• Crosses subsystem boundaries with no computation blocks in between

When you configure a model for code generation, you choose the block input and output signals to
make accessible in the generated code. For example, configure signal data to:

• Make the data accessible for interaction and monitoring while the generated code executes.
• Minimize the amount of data that is stored in memory.
• Control where the code generator places signal data in memory.
• Promote signal data to the model interface so that other components and systems can access that

data.
• Improve readability and traceability of the generated code.

The code generator checks for signal line configuration consistency. For example, the code generator
verifies that the configuration of a signal line feeding into a subsystem matches the configuration of
the signal line that exits the corresponding subsystem inport.

For code generation, examples show how to configure block signals for the model
rtwdemo_configinterface. You can configure code mappings by using the Code Mappings
editor or code mappings programming interface (coder.mapping.api.CodeMapping).

Choose Code Configuration Options for Signals
Based on your code generation requirements, decide which block signals to represent in the
generated code and how to represent the signal data. By default, signals in a model appear in
generated code as fields of a global data structure named model_B. If you do not configure
customizations, the code generator determines whether to eliminate or change the representation of
signals in generated code for optimization purposes. If you configure customizations, decide:

• Which signals to make accessible in the generated code

You must add signals that you want to make accessible in the generated code to the model code
mappings.

• Whether to set up a default configuration

If you need to gain access to a significant number (for example, more than 10) of signals , it is
more efficient to configure the signals with default settings and then override those settings for
special cases. If you need to gain access to a few signals that have unique source, naming, or
placement requirements, consider configuring the signals individually.

• How to declare and handle signal data in the generated code

• As separate global variables
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• To read input data from global variables defined in external code
• As calls to access functions. Requires Embedded Coder

For more information about these options, see “Control Data and Function Interface in Generated
Code” on page 34-44.

Other considerations include whether to:

• Name signals in the generated code by using signal labels that appear in the model or by using
unique code identifiers.

• Include the volatile type qualifier in global variable definitions and declarations. Requires
Embedded Coder. See “Protect Global Data with const and volatile Type Qualifiers” on page 43-
13.

• Place signal data into a specific area of memory. Requires Embedded Coder. See “Control Data
and Function Placement in Memory by Inserting Pragmas” on page 43-2.

For a list of interface requirements that are relevant to signals with corresponding storage classes
and storage class properties, see “Choose Storage Class and Storage Class Properties for Data
Stores” on page 33-90.

Signal requirements for example model rtwdemo_configinterface are:

• Configure signals that feed into and exit from the Switch block for code generation. Retain that
signal data for monitoring while the generated code executes.

• Represent signals as separate global variables.
• Apply prefix dout_ to names of variables that represent signals.

Set the default representation of signals in the generated code as global variables that have the
static type qualifier. Then, you configure the output signals of the two lookup table blocks to use
the default storage class and unique code identifiers that include the required prefix dout_.

Add Signals to Model Code Mappings
Before you can configure a signal for code generation, add the signal to the model code mappings.
Add the output signals for the two lookup table blocks to the model code mappings.

1 Open example model rtwdemo_configinterface. Save a copy of the model to a writable location.
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2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Individual Element Code Mappings.
4 In the Code Mappings editor, click the Signals/States tab. No signals are listed.
5 Add signals to the code mappings. For the output signal of lookup table blocks Table1 and

Table2:

a In the model, select the signal.
b Pause on the ellipsis that appears above or below the signal line to open the action bar. Click

the Add Signal button.

In the Code Mappings editor, the Signals node expands and lists the two signals that you added.
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Configure Default Code Generation Settings for Signals
A default code generation setting for signals can reduce the effort of preparing a model for code
generation, especially if a model has a significant number of signals that you want to monitor while
the generated code executes. Choose configuration settings once, and the code generator applies
those settings to signals across the model. Simulink stores the default configuration as part of the
model.

Consider configuring default code generation settings for model signals if your model uses multiple
signals that do not have unique requirements or uses a shared Embedded Coder Dictionary.

This example shows how to use the Code Mappings editor to set the default storage class for
signals in the model rtwdemo_configinterface to FileScope. With that storage class setting, the
code generator represents signal data in the generated code as global variables that have the static
type qualifier.

1 If you have not already done so, add signals to the model code mappings as described in “Add
Signals to Model Code Mappings” on page 33-52.

2 In the C Code tab, select Code Interface > Default Code Mappings.
3 In the Code Mappings editor, under Signals, select category Signals, states, and internal

data. Set the default storage class to FileScope.
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4 Save the model.

Configure Code Generation Settings for Individual Signals
You can configure individual signals for code generation. For example, if a model has two signals that
have unique code generation requirements, configure the signals individually. Or, if you configure
default settings for signals, you can override those settings for specific signals.

If your model meets at least one of these criteria, consider configuring code generation settings for
signals individually:

• Uses multiple signals that have unique source, naming, or placement requirements.
• Uses a few signals.
• Has a default configuration for signals and you need to override the configuration for some
specific signals.

This example shows how to use the Code Mappings editor to apply your default storage class setting
to the output signals of lookup table blocks Table1 and Table2 in model
rtwdemo_configinterface. The example also shows how configure code identifiers for those
output signals. You can specify code generation identifiers, for example for integration, without
modifying the model design.

1 If you have not already done so, complete the steps in “Configure Default Code Generation
Settings for Signals” on page 33-54.

2 In the Code Mappings editor, click the Signals/States tab. Expand Signals. The editor lists the
names or block port identifiers of signals that you added to the code mappings. If a signal
resolves to a signal object, a resolve-to-signal-object icon appears to the right of the element
name or port identifier. The storage class for each signal is set to Auto, which means that the
code generator might eliminate or change the representation of relevant code for optimization
purposes. If optimizations are not possible, the code generator applies the model default
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configuration. For this example, the model default configuration specifies storage class
FileScope.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that signal.

3 In the Code Mappings editor, select the output signals for blocks Table1 and Table2. Set the
storage class to Model default: FileScope.

4 Configure the code identifier for the output signals for the two lookup table blocks with names
that include the prefix dout_. In the Code Mappings editor, select signal Table1:1. In the
Property Inspector, expand the Code node. Set the storage class property Identifier to
dout_Table1. For signal Table2:1, set Identifier to dout_Table2.

5 Save the model.
6 Generate and view the code. For example, in rtwdemo_configinterface.c, find the data

definitions for the lookup table data.
static MYTYPE dout_Table1;
static MYTYPE dout_Table2;

Find where lookup table data is used in the step entry-point function.
.
.
.
  dout_Table1 = look1_binlc(input2, ((const MYTYPE *)&(mp_Table1.BP[0])), ((
    const MYTYPE *)&(mp_Table1.Table[0])), 10U);
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  if (mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
  }

  dout_Table2 = look2_binlc(input3, input4, ((const MYTYPE *)&(mp_Table2.BP1[0])),
    ((const MYTYPE *)&(mp_Table2.BP2[0])), ((const MYTYPE *)&(mp_Table2.Table[0])),
    ((const uint32_T *)&(rtwdemo_configi_Table2_maxIndex[0])), 3U);
    
  dstate_X = dout_Table2;
}

Remove Signals from Model Code Mappings
1 In the C Code tab, select Code Interface > Individual Element Code Mappings.
2 In the Code Mappings editor, click the Signals/States tab.
3 For each signal that you want to remove:

a In the model, select the signal.
b Pause on the ellipsis that appears above or below the signal line to open the action bar. Click

the Remove Signal button.

Configure Code Generation Settings for Signals Programmatically
To automate configuration of signals for code generation, use the programming interface for code
mappings. For example, when creating custom block libraries or part of an application test
environment, use the programming interface to automate data configuration.

This example shows how to use the programming interface to configure signals for model
rtwdemo_configinterface. Set the default representation of signals in the generated code as
global variables that have the static type qualifier. Then, configure the outpout signals of the two
lookup table blocks to use the default storage class and unique code identifiers that include the
required prefix dout_.

1 Open the example model.

open_system('rtwdemo_configinterface')
2 Create object cm by calling function coder.mapping.api.get. The object stores the code

generation configuration for data and functions for model rtwdemo_configinterface.

cm = coder.mapping.api.get('rtwdemo_configinterface');
3 Configure default settings for signals by calling function setDataDefault. For the arguments,

specify these values:

• The object returned by coder.mapping.api.get
• InternalData for the default category
• Property name StorageClass with property value FileScope
setDataDefault(cm,'InternalData','StorageClass','FileScope');

4 Verify your default configuration for signals. Issue a call to getDataDefault that specifies the
object returned by coder.mapping.api.get and category InternalData. Specify the third
argument as property StorageClass.

getDataDefault(cm,'InternalData','StorageClass')
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ans =

    'FileScope'
5 Get handles to the output ports for lookup table blocks Table1 and Table2. You use the port

handles to add the signal data to the model code mappings.
lut1D_ports = get_param('rtwdemo_configinterface/Table1','PortHandles');
lut2D_ports = get_param('rtwdemo_configinterface/Table2','PortHandles');

lut1D_outPort = lut1D_ports.Outport;
lut2D_outPort = lut2D_ports.Outport;

6 Add the output signals of the lookup table blocks to the model code mappings.

addSignal(cm,[lut1D_outPort,lut2D_outPort]);
7 Apply the default configuration for signals to the output signal of the lookup table blocks.

By default, Simulink sets the storage class for individual signals to Auto. The code generator:

• Determines whether to eliminate the data from the generated code for optimization purposes.
• If retaining the data, determines how to efficiently represent the data in the generated code,

taking into account default configuration settings.

To control the configuration for a signal, call function setSignal.

For each signal, issue a call to setSignal that specifies:

• Object returned by coder.mapping.api.get
• Port handle for the signal, lut1D_outport or lut2D_outport.
• Default storage class previously set for signals by using property StorageClass and

property value Model default.
• Property Identifier and property value dout_Table1 or dout_Table2
setSignal(cm,lut1D_outPort,'StorageClass','Model default','Identifier','dout_Table1');
setSignal(cm,lut2D_outPort,'StorageClass','Model default','Identifier','dout_Table2');

8 Verify your configuration settings by calling function getsignal. Specify the object returned by
coder.mapping.api.get, the port handle for the signal (lut1D_outport or
lut2D_outport), and property StorageClass or Identifier.

getSignal(cm,lut1D_outPort,'StorageClass')

ans =

    'Model default'

getSignal(cm,lut1D_outPort,'Identifier')

ans =

    'dout_Table1'

getSignal(cm,lut2D_outPort,'StorageClass')

ans =

    'Model default'
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getSignal(cm,lut2D_outPort,'Identifier')

ans =

    'dout_Table2'

9 Save the model.
10 Generate and view the code. For example, in rtwdemo_configinterface.c, find the data

definitions for the lookup table data.

static MYTYPE dout_Table1;
static MYTYPE dout_Table2;

Find where lookup table data is used in the step entry-point function.

.

.

.
  dout_Table1 = look1_binlc(input2, ((const MYTYPE *)&(mp_Table1.BP[0])), ((
    const MYTYPE *)&(mp_Table1.Table[0])), 10U);

  if (mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
  }

  dout_Table2 = look2_binlc(input3, input4, ((const MYTYPE *)&(mp_Table2.BP1[0])),
    ((const MYTYPE *)&(mp_Table2.BP2[0])), ((const MYTYPE *)&(mp_Table2.Table[0])),
    ((const uint32_T *)&(rtwdemo_configi_Table2_maxIndex[0])), 3U);
    
  dstate_X = dout_Table2;
}

Choose Storage Class and Storage Class Properties for Signals
Depending on your code generation requirements, choose from these storage classes to configure
code generation for block signals.

Requirements Storage Class to Choose
Enable optimizations, potentially generating more efficient
code.

“Auto” on page 34-76 (Individual
mappings only)

For data elements that cannot be optimized, represent data
as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping only)

Prevent optimizations from eliminating storage for a data
element and use the default storage class for the data
element category.

“Model Default” on page 34-76
(Individual mappings only) ,
Dictionary Default (Individual
mappings only)

Generate a structure that stores Boolean data in named
bitfields.

“Bitfield” on page 34-77 (Individual
mapping only)

Generate a global variable definition and declaration that
have the volatile type qualifier.

Volatile (See “Const, Volatile, and
ConstVolatile” on page 34-78)

Generate a global variable definition and declaration. “ExportedGlobal” on page 34-77
Generate a global variable definition and declaration to a
specified file.

“ExportToFile” on page 34-79
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Requirements Storage Class to Choose
Generate a global variable definition and declaration that
have the static type qualifier.

“FileScope” on page 34-80

Generate code that interacts with data by calling your
custom accessor functions.

“GetSet” on page 34-80

Generate code that reads from and writes to a global
variable or global variable pointer defined by your external
code.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

Generate code that reads from and writes to a global
variable defined by your external header file.

“ImportFromFile” on page 34-80

Generate variables that are local to functions. “Localizable” on page 34-81
Generate a global structure that has a name, which you can
specify.

“Struct” on page 34-82 (Individual
mappings only)

The list of available storage classes might include other project-specific storage classes defined in an
Embedded Coder Dictionary. If you have special requirements that are not met by the listed storage
classes and you have Embedded Coder software, you can define a storage class. See “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2.

For an individual signal, use the Identifier storage class property to configure a name for the
variable representing the signal in the generated code. With Embedded Coder, depending on the
storage class that you choose, you can also configure these properties.

Property Description Relevant Storage Classes
DefinitionFile Source definition file that contains

definitions for global data, which is read
by the signal and external code

ExportToFile and
Volatile

GetFunction signal appears in the generated code as a
call to a specified get function

GetSet

HeaderFile Source header file that contains
declarations for global data, which is read
by the signal and external code

ExportToFile, GetSet,
ImportFromFile, and
Volatile

Memory Section
(default signal
configuration only)

Memory section that contains data read by
the signal

Default

Owner Code generator places the definition for
signals in the code generated for one of
multiple models in a model hierarchy that
share definitions. You must select the
model configuration parameter Use
owner from data object for data
definition placement. See “Control
Placement of Global Data Definitions and
Declarations in Generated Files” on page
35-2.

ExportToFile and
Volatile
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Property Description Relevant Storage Classes
PreserveDimensions Code generator preserves dimensions of

signal data that is represented in
generated code as a multidimensional
array. You must set model configuration
parameter Array layout to Row-major.
See “Preserve Dimensions of
Multidimensional Arrays in Generated
Code” on page 45-2.

ExportToFile, FileScope,
ImportFromFile,
Localizable and Volatile

SetFunction Signal appears in the generated code as a
call to a specified set function.

GetSet

StructName Name for structure in the generated code
for signal.

BitField and Struct

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Configure Parameters for C Code Generation
When configuring a model for code generation, you can identify and configure parameters for
tunability, for example for calibration. Types of parameters that you can configure are listed in this
table.

Type of Parameter Description
Model parameter argument Block parameter in the model workspace that you configure as

a model argument. Each instance of a model that includes the
model parameter argument can have the argument set to a
unique value.

Model parameter Parameter defined within a model, such as a parameter in the
model workspace.

External parameter Parameter defined as an object in the base workspace or in a
data dictionary.

Constant Constant parameter.

To configure a parameter for code generation, you must associate the parameter with a data object.
For example, before configuring a MATLAB variable for code generation, in the Model Explorer,
convert the variable to a parameter object.

When you open a model in the Embedded Coder app, model parameters, model parameter
arguments, and constants that are associated with data objects appear in the Code Mappings editor.
In the editor, you can configure the parameters for code generation. If a model uses external
parameters, you can add them to the Code Mappings editor by clicking the Refresh link to the right
of the parameter name. That link initiates an update diagram and, in the editor view, adds external
parameters that are used by the model.

Configure parameter data to:

• Make the data accessible for interaction while the generated code executes.
• Minimize the amount of data that is stored in memory.
• Control where the code generator places parameter data in memory.
• Promote parameter data to the model interface so that other components and systems can access

that data.
• Improve readability and traceability of the generated code.

To control whether the parameters throughout a model are tunable, you can gain access to model
configuration parameter Default parameter behavior by using the 'Auto' will be tunable/
inline link on the Code Mappings editor Data Defaults tab. For example, you can use that link to
make parameters tunable in these cases:

• Refine parameter settings during rapid prototyping
• Calibrate parameters
• Optimize parameters for production code

For code generation, examples show how to configure model parameters and model parameter
arguments for the model rtwdemo_configinterface. You can configure code mappings by using
the Code Mappings editor or code mappings programming interface
(coder.mapping.api.CodeMapping).
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Choose Customization Options for Parameters
By default, parameters in a model appear in generated code as fields of global data structures named:

• model_P for model parameters
• model_InstP for model parameter arguments
• model_ConstP for constant parameters

Based on your code interface requirements, decide whether to customize generation of parameter
data. If you do not configure customizations, the code generator determines whether to eliminate or
change the representation of parameters in generated code for optimization purposes. If you
configure customizations, decide:

• Whether to set up a default configuration

If a model includes a significant number of parameters of a category that must be tunable (for
example, more than 10), it is more efficient to configure the parameters of that category by using
a default setting, and then override that setting for special cases. If the model includes a few
parameters of a given category that have unique source, naming, or placement requirements,
consider configuring the parameters individually.

• How to declare and handle model parameter data in the generated code

• As separate global variables
• To read model parameter data from global variables defined in external code
• As calls to access functions. Requires Embedded Coder

For more information about these options, see “Control Data and Function Interface in Generated
Code” on page 34-44.

Other considerations for model parameters include whether to:

• Name parameters in the generated code by using parameter names in the model or by using
unique code identifiers.

• Support preprocessor conditionals defined by compiler flags or options. Requires Embedded
Coder. See “Use Variant Models to Generate Code That Uses C Preprocessor Conditionals” on
page 26-68.

• Include the static type qualifier in global variable definitions and declarations, for example, to
prevent name clashes. Requires Embedded Coder. See “Prevent Name Clashes by Configuring
Data Item as static” on page 35-8.

• Include the const, volatile, or const and volatile type qualifier in global variable
definitions and declarations. Requires Embedded Coder. See “Protect Global Data with const and
volatile Type Qualifiers” on page 43-13.

• Generate a macro (#define) or code that uses a macro defined in an external header file.
Requires Embedded Coder. See “Macro Definitions (#define)” on page 25-54.

• Generate a global data structure with a name that you specify. Requires Embedded Coder. See
“Organize Data into Structures in Generated Code” on page 34-145.

• Place parameter data into a specific area of memory. Requires Embedded Coder. See “Control
Data and Function Placement in Memory by Inserting Pragmas” on page 43-2.
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For a list of interface requirements that are relevant to parameters that have corresponding storage
classes and storage class properties, see “Choose Storage Class and Storage Class Properties for
Data Stores” on page 33-90.

Parameter requirements for example model rtwdemo_configinterface are:

• By default, retain model parameters in the generated code for tuning. Do not optimize the code by
inlining the parameters.

• Represent model parameters as separate global variables defined and declared with the const
and volatile type qualifiers.

• Apply prefix mp_ to names of variables that represent model parameters.
• Enable constant parameters UPPER and LOWER to have different values for each instance of the

model.
• For each instance of a model parameter argument, by default, allocate an area of memory

represented as a uniquely named field in an exported structure.
• Model parameter arguments appear as individual model function arguments in the generated

code. Enable the code generator to optimize model parameter arguments that are not used by
blocks in the model.

For this example, configure model parameters and model parameter arguments in
rtwdemo_configinterface to meet these code generation requirements.

Configure Default Code Generation Settings for Parameters
Default code generation settings for parameters can reduce the effort of preparing a model for code
generation, especially if a model has a significant number of parameters with which you need to
interact while the generated code executes. Choose configuration settings once, and the code
generator applies those settings to parameters across the model. Simulink stores the default
configuration as part of the model.

Consider configuring default code generation settings for model parameters if your model uses
multiple parameters for the same category that do not have unique requirements or use a shared
Embedded Coder Dictionary.

This example shows how to use the Code Mappings editor to configure default settings for model
parameters and model parameter arguments for the model rtwdemo_configinterface. Configure
model parameters so that they are tunable and are defined and declared in the generated code as
separate global variables that have type qualifiers const and volatile. Configure model parameter
arguments to use default settings, where the code generator allocates an area of memory
represented as a uniquely named field in an exported structure for each argument instance.

1 Open model rtwdemo_configinterface. Save a copy of the model to a writable location.
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2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Default Code Mappings.
4 In the Code Mappings editor, select Model parameter arguments. Leave the storage class set

to Default. The code generator allocates a separate area of memory for each argument
instance.

5 In the Code Mappings editor, under Parameters, select category Model parameters. Link text
'Auto' will be inlined indicates that the code generator is configured to inline model
parameters by default. A requirement for this example is model parameters be tunable. Click
'Auto' will be inlined.

6 In the Model Configuration Parameters dialog box, set model configuration parameter Default
parameter behavior to Tunable. Save the change and close the dialog box. In the Code
Mappings editor, the link text changes to 'Auto' will be tunable.

7 In the Code Mappings, with the Model parameters category still selected, set the storage class
to ConstVolatile.
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8 Save the model.

Configure Code Generation for Individual Parameters
You can configure individual parameters for code generation. For example, if a model has two
parameters of the same category that have unique code generation requirements, configure the
parameters individually. Or, if you configure default settings for a category of parameters, you can
override those settings for specific parameters.

If your model meets at least one of these criteria, consider configuring code generation settings for
parameters individually:

• Uses multiple parameters of the same category that have unique source, naming, or placement
requirements.

• Uses a few parameters of the same category.
• Has a default configuration for a category of parameters and you need to override the
configuration for some specific parameters.

This example shows how to use the Code Mappings editor to apply your default storage class setting
for model parameters to parameters K1, Table1, and Table2 in model
rtwdemo_configinterface. You configure code identifiers for those parameters and for model
parameter arguments LOWER and UPPER. You can specify code generation identifiers, for example for
integration, without modifying the model design.

1 If you have not already done so, complete the steps in “Configure Default Code Generation
Settings for Parameters” on page 33-64.

2 In the Code Mappings editor, click the Parameters tab. Expand Model Parameter Arguments.
By default, the storage class for each model parameter is set to Auto, which means that the code
generator might eliminate or change the representation of relevant code for optimization
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purposes. If optimizations are not possible, the code generator applies the model default
configuration. For this example, leave the storage class set to Auto.

3 Expand Model Parameters. By default, the storage class for each parameter is set to Auto. Use
the model default configuration, which specifies storage class ConstVolatile.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that parameter.

4 In the Code Mappings editor, under Model Parameters, select parameters K1, Table1, and
Table2. Set the storage class to Model default: ConstVolatile.

5 Configure the code identifiers for model parameters with names that include the prefix mp_. In
the Code Mappings editor, select model parameter K1. In the Property Inspector, expand the
Code node. Set the storage class property Identifier to mp_K1. For parameters Table1 and
Table2, set Identifier to mp_Table1 and mp_Table2.
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6 Save the model.
7 Generate and view the code. For example, find the data definitions for model parameter mp_K1 in

rtwdemo_configinterface.c.

const volatile int8_T mp_K1 = 2; 

Find where the parameter is used in the step entry-point function.
if (mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
  }

Organize Parameter Data into a Structure by Using Struct Storage
Class
This example shows how to use the Struct storage class to organize block parameter values into a
structure in the generated code. You apply the storage class directly to individual data items in a
model.

To create a custom structure of parameter data in the generated code, consider creating a
corresponding structure in Simulink. See “Organize Data into Structures in Generated Code” on page
34-145.
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Create the Example Model

Create this example model with three Constant blocks and three Outport blocks. Name the model
ex_struct_param.

Set Up Constant Parameters

1 Open the Model Data Editor. On the Modeling tab, click Model Data Editor.
2 In the Model Data Editor, select the Parameters tab.
3 In the model, select the upper Constant block.
4 In the Model Data Editor, use the Value column to set the constant value to p1. Next to p1, click

the action button  and select Create.
5 In the Create New Data dialog box, set Value to Simulink.Parameter(1.0) and click Create.

Simulink adds a Simulink.Parameter object named p1 to the model workspace.
6 In the property dialog box for p1, click OK.

If you did not have to set up other parameters, you could click the Code Generation tab. Then,
click the Configure in Coder App button, which opens the Embedded Coder app and Code
Mappings editor.

7 Use the Model Data Editor to set the other constant values by using parameter objects named p2
(value 2.0) and p3 (value 3.0).

Configure Constant Parameters for Code Generation

1 Open the Embedded Coder app.
2 On the C Code tab, select Code Interface > Individual Element Code Mappings.
3 In the Code Mappings editor, click the Parameters tab.
4 Expand Model Parameters.
5 Set the storage class for parameters p1, p2, and p3 to Struct.
6 Select parameter p1. In the Property Inspector, under Code, set property StructName to

my_struct. For parameters p2 and p3, set StructNameto my_struct.
7 Save the model.

Generate and Inspect Code

Generate and inspect the code.

The file ex_struct_param.h defines structure type, my_struct_type.
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/* Type definition for custom storage class: Struct */
   typedef struct my_struct_tag {
      real_T p1;
      real_T p2;
      real_T p3;
   } my_struct_type;

The file ex_struct_param.c defines global variable my_struct.
/* Definition for custom storage class: Struct */
my_struct_type my_struct = {
     /* p1 */
     1.0,

     /* p2 */
     2.0,

     /* p3 */
     3.0
};

Configure Code Generation Settings for Parameters Programmatically
To automate configuration of parameters for code generation, use the programming interface for
code mappings. For example, when creating custom block libraries or part of an application test
environment, use the programming interface to automate data configuration.

This example shows how to configure default settings for model parameters and model parameter
arguments for model rtwdemo_configinterface. Configure model parameters so that they are tunable
and are defined and declared in the generated code as separate global variables that have type
qualifiers const and volatile. Configure model parameter arguments to use default settings,
where the code generator allocates an area of memory represented as a uniquely named field in an
exported structure for each argument instance. Apply your default storage class setting for model
parameters to parameters K1, Table1, and Table2. Configure code identifiers for those parameters.

1 Open the example model.

open_system('rtwdemo_configinterface');
2 Set model configuration parameter Default parameter behavior to Tunable.

model='rtwdemo_configinterface';

set_param(model,'DefaultParameterBehavior','Tunable');
3 Create object cm by calling function coder.mapping.api.get. The object stores the code

generation configuration for data elements and functions in model rtwdemo_configdefaults.

cm = coder.mapping.api.get('rtwdemo_configinterface');
4 Configure default settings for model parameters by calling function setDataDefault. For the

arguments, specify these values:

• The object returned by coder.mapping.api.get
• ModelParameters for the default category
• Property name StorageClass with property value ConstVolatile
setDataDefault(cm,'ModelParameters','StorageClass','ConstVolatile');

5 Configure default settings for model parameter arguments. In the call to setDataDefault,
specify these values for arguments:

• The object returned by coder.mapping.api.get.
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• ModelParameterArguments for the default category.
• Property name StorageClass with property value Default.

setDataDefault(cm,'ModelParameterArguments','StorageClass','Default');

6 Verify your default configuration for model parameters and model parameter arguments. Issue
calls to getDataDefault that specify the object returned by coder.mapping.api.get,
category ModelParameters or ModelParameterArguments, and StorageClass.

getDataDefault(cm, 'ModelParameters', 'StorageClass')

ans =

    'ConstVolatile'

getDataDefault(cm, 'ModelParameterArguments', 'StorageClass')

ans =

    'Default'
7 Apply the default configuration for model parameters to parameters K1, Table1, and Table2 .

By default, Simulink sets the storage class for individual parameters to Auto. When the storage
class is Auto, the code generator:

• Determines whether to eliminate the data from the generated code for optimization purposes.
• If retaining the data, determines how to efficiently represent the data in the generated code,

taking into account default configuration settings.

Configure the code generator to apply your default model parameter settings to parameters K1,
Table1, and Table2. For each parameter, call function setModelParameter. Specify the
object returned by coder.mapping.api.get, the parameter name, property name
StorageClass, and property value Model default.

setModelParameter(cm,'K1','StorageClass','Model default');
setModelParameter(cm,'Table1','StorageClass','Model default');
setModelParameter(cm,'Table2','StorageClass','Model default');

8 Verify your configuration changes for parameters K1, Table1, and Table2 by using calls to
function getModelParameter.

getModelParameter(cm,'K1','StorageClass')

ans =

    'Model default'

getModelParameter(cm,'Table1','StorageClass')

ans =

    'Model default'

getModelParameter(cm,'Table2','StorageClass')

ans =
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    'Model default'
9 Configure code identifiers for the model parameters. For each parameter, call function

setModelParameter. Specify the object returned by coder.mapping.api.get, the parameter
name, property name Identifier, and one of these property values.

Model Parameter Code Identifier
K1 mp_K1
Table1 mp_Table1
Table2 mp_Table2

setModelParameter(cm,'K1','Identifier','mp_K1');
setModelParameter(cm,'Table1','Identifier','mp_Table1');
setModelParameter(cm,'Table2','Identifier','mp_Table2');

10 Verify your configuration changes for the model parameters by using calls to function
getModelParameter.

getModelParameter(cm,'K1','Identifier')

ans =

    'mp_K1'

getModelParameter(cm,'Table1','Identifier')

ans =

    'mp_Table1'

getModelParameter(cm, 'Table2', 'Identifier')

ans =

    'mp_Table2'
11 Save the model.
12 Generate and view the code. For example, find the data definitions for model parameter mp_K1 in

rtwdemo_configinterface.c.

const volatile int8_T mp_K1 = 2; 

Find where the parameter is used in the step entry-point function.
if (mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
  }

Choose Storage Class and Storage Class Properties for Model
Parameters
Depending on your code generation requirements, choose from these storage classes to configure
code generation for model parameters. For constants, only Default applies. For model parameter
arguments, only Auto, Default, and Model default apply.
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Requirements Storage Class
Enable optimizations, potentially generating more efficient
code.

“Auto” on page 34-76 (Individual
mappings only)

For data elements that cannot be optimized, represent data
as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping only)

Prevent optimizations from eliminating storage for a data
element and use the default mapping for the data element
category.

“Model Default” on page 34-76
(Individual mappings only) ,
Dictionary Default (Individual
mappings only)

Generate a structure that stores Boolean data in named
bitfields.

“Bitfield” on page 34-77 (Individual
mapping only)

Support preprocessor conditionals defined by using a
compiler flag or option.

“CompilerFlag” on page 34-78

Generate a global variable definition and declaration that
has the const, volatile, or const and volatile type
qualifiers.

“Const, Volatile, and ConstVolatile” on
page 34-78

Generate a macro (#define directive) or code that uses a
macro defined in a header file in your external code.

“Define, ImportedDefine” on page 34-
79

Generate a global variable definition and declaration. “ExportedGlobal” on page 34-77
Generate a global variable definition and declaration to a
specified file.

“ExportToFile” on page 34-79

Generate a global variable definition and declaration that
has the static type qualifier.

“FileScope” on page 34-80 (Local and
shared local data store mappings only)

Generate code that interacts with data by calling your
custom accessor functions.

“GetSet” on page 34-80

Generate code that reads from and writes to a global
variable or global variable pointer defined by your external
code.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

Generate code that reads from and writes to a global
variable defined by your external header file.

“ImportFromFile” on page 34-80

Generate a global structure that has a name, which you can
specify.

“Struct” on page 34-82 (Individual
mappings only)

The list of available storage classes might include other project-specific storage classes defined in an
Embedded Coder Dictionary. If you have special requirements that are not met by the listed storage
classes and you have Embedded Coder software, you can define a storage class. See “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2.

For an individual model parameter, use the Identifier storage class property to configure a name for
the variable representing the parameter in the generated code. With Embedded Coder, depending on
the storage class that you choose, you can also configure these properties.

Property Description Storage Classes
DefinitionFile Source definition file that contains

definitions for global data, which is read
by the parameter and external code

ExportToFile and
Volatile
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Property Description Storage Classes
GetFunction Parameter appears in the generated code

as a call to a specified get function
GetSet

HeaderFile Source header file that contains
declarations for global data, which is read
by the parameter and external code

ExportToFile, GetSet,
ImportFromFile, and
Volatile

Memory Section
(default parameter
configuration only)

Memory section that contains data read by
the parameter

Default

Owner Code generator places the definition for
parameters in the code generated for one
of multiple models in a model hierarchy
that share definitions. You must select the
model configuration parameter Use
owner from data object for data
definition placement. See “Control
Placement of Global Data Definitions and
Declarations in Generated Files” on page
35-2.

ExportToFile and
Volatile

PreserveDimensions Code generator preserves dimensions of
parameter data that is represented in
generated code as a multidimensional
array. You must set model configuration
parameter Array layout to Row-major.
See “Preserve Dimensions of
Multidimensional Arrays in Generated
Code” on page 45-2.

ExportToFile, FileScope,
ImportFromFile,
Localizable and Volatile

SetFunction Parameter appears in the generated code
as a call to a specified set function.

GetSet

StructName Name for a structure in the generated
code for parameter.

BitField and Struct

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Configure Block States for C Code Generation
Block states, such as the state of a Unit Delay block, retain a state value between execution cycles of
an algorithm. When configuring a model for code generation, you can configure state data to:

• Minimize the amount of data that is stored in memory.
• Control where the code generator places state data in memory.
• Promote state data to the model interface so that other components and systems can access that

data.
• Improve readability and traceability of the generated code.

For code generation, examples show how to configure a block state for model
rtwdemo_configinterface. You can configure code mappings by using the Code Mappings
editor or code mappings programming interface (coder.mapping.api.CodeMapping).

Choose Code Configuration Options for States
Based on your code generation requirements, decide how to represent state data. By default, states
in a model appear in generated code as fields of a global data structure named model_DW. If you do
not configure customizations, the code generator determines whether to eliminate or change the
representation of states in generated code for optimization purposes. If you configure customizations,
decide:

• Whether to set up a default configuration

If you need to gain access to a significant number of states (for example, more than 10) , it is more
efficient to configure the states with default settings and then override those settings for special
cases. If you need to gain access to a few states that have unique source, naming, or placement
requirements, consider configuring the states individually.

• How to declare and handle state data in the generated code

• As separate global variables
• To read input data from global variables defined in external code
• As calls to access functions. Requires Embedded Coder

For more information about these options, see “Control Data and Function Interface in Generated
Code” on page 34-44.

Other considerations include whether to:

• Name states in the generated code by using state labels that appear in the model or by using
unique code identifiers.

• Include the volatile type qualifier in global variable definitions and declarations. Requires
Embedded Coder. See “Protect Global Data with const and volatile Type Qualifiers” on page 43-
13.

• Place state data into a specific area of memory. Requires Embedded Coder. See “Control Data and
Function Placement in Memory by Inserting Pragmas” on page 43-2.

For a list of interface requirements that are relevant to states with corresponding storage classes and
storage class properties, see “Choose Storage Class and Storage Class Properties for Data Stores” on
page 33-90.
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State requirements for example model rtwdemo_configinterface are:

• Retain the state data of the Unit Delay block for accessibility while the generated code executes.
• Represent the state as a separate global variable.
• Apply prefix dtemp_ to the name of the variable that represents the state.

For this example, you set the default representation of the state in the generated code as a global
variable with the static type qualifier. Then, you configure the state of the Unit Delay block to use
the default storage class and a unique code identifier that includes the required prefix dtemp_. The
code identifier capability enables you to specify code generation identifiers without having to modify
the model design.

Configure Default Code Generation Settings for States
A default code generation setting for states can reduce the effort of preparing a model for code
generation, especially if a model has a significant number of states that you want to gain access to
while the generated code executes. Choose configuration settings once, and the code generator
applies those settings to states across the model. Simulink stores the default configuration as part of
the model.

Consider configuring default code generation settings for model states if your model uses multiple
states that do not have unique requirements or uses a shared Embedded Coder Dictionary.

This example shows how to use the Code Mappings editor to configure default settings for states.
Use the Code Mappings editor to set the default storage class for states in model
rtwdemo_configinterface to FileScope. With that storage class setting, the code generator
represents state data in the generated code as global variables that have the static type qualifier.

1 Open model rtwdemo_configinterface. Save a copy of the model to a writable location.
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2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Default Code Mappings.
4 In the Code Mappings editor, under Signals, select category Signals, states, and internal

data. Set the default storage class to FileScope.

5 Save the model.

Configure Code Generation Settings for Individual States
You can configure individual states for code generation. For example, if a model has two states that
have unique code generation requirements, configure the states individually. Or, if you configure
default settings for states, you can override those settings for specific states.

If your model meets at least one of these criteria, consider configuring code generation settings for
states individually:

• Uses multiple states that have unique source, naming, or placement requirements.
• Uses a few states.
• Has a default configuration for states and you need to override the configuration for some specific

states.

This example shows how to use the Code Mappings editor to apply your default storage class setting
to the Unit Delay block state X in model rtwdemo_configinterface.

The example also shows how to configure a code identifier for that state. You can specify code
generation identifiers, for example for integration, without modifying the model design.

1 If you have not already done so, complete the steps in “Configure Default Code Generation
Settings for States” on page 33-76.

2 In the Code Mappings editor, click the Signals/States tab. Expand States. The storage class for
the state is set to Auto, which means that the code generator might eliminate or change the
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representation of relevant code for optimization purposes. If optimizations are not possible, the
code generator applies the model default configuration. For this example, the model default
configuration specifies storage class FileScope.

• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that state.

3 In the Code Mappings editor, select state X. Set the storage class to .
4 Configure the code identifier for the state with a name that includes the prefix dstate_. In the

Code Mappings editor, select state X. In the Property Inspector, expand the Code node. Then, set
the storage class property Identifier to dstate_X.

5 Save the model.
6 Generate and view the code. For example, in rtwdemo_configinterface.c, find the data

definitions for the state data.
static MYTYPE dstate_X;

Find where the state data is used in the step entry-point function.
.
.
.
  if (mode) {
    output = (real_T)mp_K1 * dout_Table1;  
  } else {
    output = dstate_X;
  }
.
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.

.
   dstate_X = dout_Table2;
}

Configure Code Generation Settings for States Programmatically
To automate configuration of states for code generation, use the programming interface for code
mappings. For example, when creating custom block libraries or as part of creating an application
test environment, use the programming interface to automate data configuration.

This example shows how to use the programming interface to configure states for model
rtwdemo_configinterface. Set the default representation of states in the generated code as global
variables that have the static type qualifier. Then, configure state X of the Unit Delay block to use
the default storage class and unique code identifier that includes the required prefix dstate_.

1 Open the example model.

open_system('rtwdemo_configinterface')
2 Create object cm by calling function coder.mapping.api.get. The object stores the code

generation configuration for data and functions for model rtwdemo_configinterface.

cm = coder.mapping.api.get('rtwdemo_configinterface');
3 Configure default settings for states by calling function setDataDefault. For the arguments,

specify these values:

• The object returned by coder.mapping.api.get
• InternalData for the default category
• Property name StorageClass with property value FileScope

setDataDefault(cm,'InternalData','StorageClass','FileScope');

4 Verify your default configuration for states. Issue a call to getDataDefault that specifies the
object returned by coder.mapping.api.get and category InternalData. Specify the third
argument as property StorageClass.

getDataDefault(cm,'InternalData','StorageClass')

ans =

    'FileScope'
5 Apply the default configuration for states to state X.

By default, Simulink sets the storage class for individual states to Auto. The code generator:

• Determines whether to eliminate the data from the generated code for optimization purposes.
• If retaining the data, determines how to efficiently represent the data in the generated code,

taking into account default configuration settings.

To control the configuration for a state, call function setState.

Issue a call to setState that specifies:

• Object returned by coder.mapping.api.get
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• State name X
• Default storage class previously set for states by using property StorageClass and property

value Model default.
• Property Identifier and property value dstate_X

setState(cm,'X','StorageClass','Model default','Identifier','dstate_X');

6 Verify your configuration changes by calling function getState. Specify the object returned by
coder.mapping.api.get, name of the state, and property StorageClass or Identifier.

getState(cm,'X','StorageClass')

ans =

    'Model default'

getState(cm,'X','Identifier')

ans =

    'dstate_X'

7 Save the model.
8 Generate and view the code. For example, in rtwdemo_configinterface.c, find the data

definitions for state data.

static MYTYPE dstate_X;

Find where the state data is used in the step entry-point function.

.

.

.
  if (mode) {
    output = (real_T)mp_K1 * dout_Table1;  
  } else {
    output = dstate_X;
  }
.
.
.
   dstate_X = dout_Table2;
}

Choose Storage Class and Storage Class Properties for States
Depending on your code generation requirements, choose from these storage classes to configure
code generation for block states.

Requirements Storage Class
Let the code generator handle how to represent the state in
the generated code. For example, for optimization
purposes, the code generator might eliminate or change the
representation of data.

“Auto” on page 34-76 (Individual
mappings only)

For data elements that cannot be optimized, represent data
as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping only)
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Requirements Storage Class
Prevent optimizations from eliminating storage for a data
element and use the default mapping for the data element
category.

“Model Default” on page 34-76
(Individual mappings only) ,
Dictionary Default (Individual
mappings only)

Generate a structure that stores Boolean data in named
bitfields.

“Bitfield” on page 34-77 (Individual
mapping only)

Generate a global variable definition and declaration that
has the volatile type qualifier.

Volatile (See “Const, Volatile, and
ConstVolatile” on page 34-78)

Generate a global variable definition and declaration. “ExportedGlobal” on page 34-77
Generate a global variable definition and declaration to a
specified file.

“ExportToFile” on page 34-79

Generate a global variable definition and declaration that
has the static type qualifier.

“FileScope” on page 34-80 (Local and
shared local data store mappings only)

Generate code that interacts with data by calling your
custom accessor functions.

“GetSet” on page 34-80

Generate code that reads from and writes to a global
variable or global variable pointer defined by your external
code.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

“ExportToFile” on page 34-79 “ImportFromFile” on page 34-80
Generate variables that are local to functions. “Localizable” on page 34-81
Generate a global structure that has a name, which you can
specify.

“Struct” on page 34-82 (Individual
mappings only)

The list of available storage classes might include other project-specific storage classes defined in an
Embedded Coder Dictionary. If you have special requirements that are not met by the listed storage
classes and you have Embedded Coder software, you can define a storage class. See “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2.

For an individual state, use the Identifier storage class property to configure a name for the variable
representing the state in the generated code. With Embedded Coder, depending on the storage class
that you choose, you can also configure these properties.

Property Description Storage Classes
DefinitionFile Source definition file that contains

definitions for global data, which is read
by the state and external code

ExportToFile and
Volatile

GetFunction State appears in the generated code as a
call to a specified get function

GetSet

HeaderFile Source header file that contains
declarations for global data, which is read
by the state and external code

ExportToFile, GetSet,
ImportFromFile, and
Volatile

Memory Section
(default state
configuration only)

Memory section that contains data read by
the state

Default
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Property Description Storage Classes
Owner Code generator places the definition for

states in the code generated for one of
multiple models in a model hierarchy that
share definitions. You must select the
model configuration parameter Use
owner from data object for data
definition placement. See “Control
Placement of Global Data Definitions and
Declarations in Generated Files” on page
35-2.

ExportToFile and
Volatile

PreserveDimensions Code generator preserves dimensions of
state data that is represented in generated
code as a multidimensional array. You
must set model configuration parameter
Array layout to Row-major. See
“Preserve Dimensions of Multidimensional
Arrays in Generated Code” on page 45-
2.

ExportToFile, FileScope,
ImportFromFile,
Localizable and Volatile

SetFunction State appears in the generated code as a
call to a specified set function.

GetSet

StructName Name for a structure in the generated
code for state.

BitField and Struct

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Configure Data Stores for C Code Generation
Data stores enable subsystems and referenced models to share data without using I/O ports to pass
the data from level to level (see “Data Store Basics” and “Data Stores in Generated Code” on page
34-92). Types of data stores include the types listed in this table.

Type of Data Store Description
Local data store Data store that is accessible from anywhere in a model hierarchy

that is at or below the level at which you define the data store.
You can define a local data store graphically in a model by
including a Data Store Memory block or by creating a signal
object (synthesized data store) in the model workspace.

Shared local data store Data Store Memory block with the block parameter Share
across model instances set. These data stores are accessible
only in the model where they are defined. The data store value is
shared across instances of the model.

Global data store Data store that is defined by a signal object in the base
workspace or in a data dictionary. Multiple models in an
application can use these data stores.

When you open a model in the Embedded Coder app, local and shared local data stores appear in
the Code Mappings editor, where you can configure the data stores for code generation. If a model
uses global data stores, you can view them in the Code Mappings editor by clicking the Refresh link
that appears to the right of the data store name. That link initiates an update diagram and adds
global data stores that the model uses in the editor view.

Configure data stores to:

• Make data accessible for interaction while the generated code executes.
• Control where the code generator places data in memory.
• Improve readability and traceability of generated code.

For code generation, examples show how to configure a data store for model
rtwdemo_configinterface. You can configure code mappings by using the Code Mappings
editor or code mappings API (coder.mapping.api.CodeMapping).

Choose Customization Options for Data Stores
By default, local data stores in a model appear in generated code as fields of a global data structure
named model_DW. Shared local data stores appear as a field of global data structure
model_SharedDSM. Based on your code interface requirements, decide whether to customize code
generation of data stores. If you do not configure customizations, the code generator determines
whether to eliminate or change the representation of data stores in generated code for optimization
purposes. If you configure customizations, decide:

• Whether to set up a default configuration

If a model includes a significant number (for example, more than 10) of data stores for a given
category that must be accessible during program execution, it is more efficient to configure the
data stores with a default setting, and then override that setting for special cases. If the model
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includes a few data stores for a given category that have unique source, naming, or placement
requirements, consider configuring the data stores individually.

• How to declare and handle model data stores in the generated code

• As separate global variables
• To read from data stores as global variables defined in external code
• As calls to access functions. Requires Embedded Coder

For more information about these options, see “Control Data and Function Interface in Generated
Code” on page 34-44.

Other considerations for model parameters include whether to:

• Name data stores in the generated code by using data store names in the model or by using
unique code identifiers.

• Include the static type qualifier in global variable definitions and declarations, for example, to
prevent name clashes. Requires Embedded Coder. See “Prevent Name Clashes by Configuring
Data Item as static” on page 35-8.

• Include the volatile type qualifier in global variable definitions and declarations. Requires
Embedded Coder. See “Protect Global Data with const and volatile Type Qualifiers” on page 43-
13.

• Generate a global data structure with a name that you specify. Requires Embedded Coder. See
“Organize Data into Structures in Generated Code” on page 34-145.

• Place data stores in a specific area of memory. Requires Embedded Coder. See “Control Data and
Function Placement in Memory by Inserting Pragmas” on page 43-2.

For a list of interface requirements that are relevant to data stores with corresponding storage
classes and storage class properties, see “Choose Storage Class and Storage Class Properties for
Data Stores” on page 33-90.

For example model rtwdemo_configinterface, data store requirements are:

• Represent local data stores as separate global variables defined and declared with the static
type qualifier.

• Represent shared local data stores as separate global variables defined and declared with the
volatile type qualifier.

• Apply prefix ds_ to names of variables that represent data stores.

For this example, you set the default representation for local data stores in the generated code as
global variables that have the static type qualifier and shared local data stores as global variables
that have the volatile type qualifier. Then, you configure the local data store in the model to use
the default storage class and a unique code identifier that includes the required prefix ds_. The code
identifier capability enables you to specify code generation identifiers without having to modify the
model design.

Configure Default Code Generation Settings for Data Stores
Default code generation settings for data stores can reduce the effort of preparing a model for code
generation, especially if a model has a significant number of data stores that you want to gain access
to while the generated code executes. Choose configuration settings once, and the code generator
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applies those settings to data stores across the model. Simulink stores the default configuration as
part of the model.

Consider configuring default code generation settings for model data stores if your model uses
multiple data stores for a given category that do not have unique requirements or use a shared
Embedded Coder Dictionary.

This example shows how to use the Code Mappings editor to configure default settings for data
stores. Use the Code Mappings editor to set the default storage class for local and shared local data
stores in model rtwdemo_configinterface to FileScope and Volatile, respectively. With those
storage class settings, the code generator represents the data stores in the generated code as global
variables that have the static and volatile type qualifiers.

1 Open model rtwdemo_configinterface. Save a copy of the model to a writable location.

2 Open the Embedded Coder app.
3 In the C Code tab, select Code Interface > Default Code Mappings.
4 Configure default code mappings for local data stores. In the Code Mappings editor, on the Data

Defaults tab, expand the Signals node. Select category Signals, states, and internal data.
Set the storage class to FileScope.
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5 Configure default code mappings for shared local data stores. Select category Shared local data
stores. Set the storage class to Volatile.

6 Save the model.

Configure Code Generation for Individual Data Stores
You can configure individual data stores for code generation. For example, if a model has two data
stores of the same category that have unique code generation requirements, configure the data stores
individually. Or, if you configure default settings for a category of data stores, you can override those
settings for specific data stores.

If your model meets at least one of these criteria, consider configuring code generation settings for
data stores individually:

• Uses multiple data stores of the same category that have unique source, naming, or placement
requirements.

• Uses a few data stores of the same category.
• Has a default configuration for a category of data stores and you need to override the
configuration for some specific states.

This example shows how to use the Code Mappings editor to apply your default storage class setting
to the Data Store Memory block mode in model rtwdemo_configinterface. The example also
shows how configure a code identifier for that data store.

1 If you have not already done so, complete the steps in “Configure Default Code Generation
Settings for Data Stores” on page 33-84.

2 In the Code Mappings editor, click the Data Stores tab. Expand Local Data Stores. The storage
class for data store mode is set to Auto, which means that the code generator might eliminate or
change the representation of relevant code for optimization purposes. If optimizations are not
possible, the code generator applies the model default configuration. For this example, the model
default configuration specifies the storage class Volatile.
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• To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default.

• To override the default configuration, specify the storage class that meets the code generation
requirements for that data store.

3 In the Code Mappings editor, select local data store mode. Set the storage class to Model
default: Volatile.

4 Configure the code identifier for the data store with a name that includes the prefix ds_. In the
Code Mappings editor, select shared local data store mode. In the Property Inspector, expand the
Code node. Set the storage class property Identifier to ds_mode.

5 Save the model.
6 Generate and view the code. For example, in rtwdemo_configinterface.c, find the data

definitions for the data store.
static boolean_T ds_mode;

Find where the state data is used in the step entry-point function.
.
.
.
  ds_mode = ((input1 > rtwdemo_configinterface_UPPER) || (input1 <
              rtwdemo_configinterface_LOWER));
.
.
.
  if (ds_mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
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    output = dstate_X;
  }
.
.
.

Configure Code Generation Settings for Data Stores Programmatically
To automate configuration of data stores for code generation, use the programming interface for code
mappings. For example, when creating custom block libraries or part of an application test
environment, use the programming interface to automate data configuration.

This example shows how to use the programming interface to configure data stores for model
rtwdemo_configinterface. Set the default representation of local and shared local data stores in the
generated code as global variables that have the static and volatile type qualifier, respectively.
Configure the Data Store Memory block mode to use the default storage class and a unique code
identifier that includes the required prefix ds_.

1 Open the example model.

open_system('rtwdemo_configinterface')
2 Create object cm by calling function coder.mapping.api.get. The object stores the data and

function code generation configuration for model rtwdemo_configinterface.

cm = coder.mapping.api.get('rtwdemo_configinterface');
3 Configure default settings for local data stores by calling function setDataDefault. For the

arguments, specify these values:

• The object returned by coder.mapping.api.get
• InternalData for the default category
• Property name StorageClass with property value FileScope
setDataDefault(cm,'InternalData','StorageClass','FileScope');

4 Configure default settings for shared local data stores by calling function setDataDefault.
Specify these values for arguments:

• The object returned by coder.mapping.api.get.
• SharedLocalDataStore for the default category.
• Property name StorageClass with property value Volatile.
setDataDefault(cm,'SharedLocalDataStore','StorageClass','Volatile');

5 Verify your default configuration settings for local and shared local data stores. Issue a call to
getDataDefault that specifies the object returned by coder.mapping.api.get, category
InternalData, and the property StorageClass. In a second call to getDataDefault, replace
the category with SharedLocalDataStore.

getDataDefault(cm,'Internal','StorageClass')

ans =

    'FileScope'

getDataDefault(cm,'SharedLocalDataStore','StorageClass')
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ans =

    'Volatile'
6 Apply the default configuration for local data store mode.

By default, Simulink sets the storage class for data stores to Auto. When the storage class is
Auto, the code generator:

• Determines whether to eliminate the data from the generated code for optimization purposes.
• If retaining the data, determines how to efficiently represent the data in the generated code,

taking into account default configuration settings.

To control the configuration for an individual data store, call function setDataStore. Issue a
call to setDataStore that specifies:

• Object returned by coder.mapping.api.get
• Data store name mode
• Default storage class previously set for the data store by using property StorageClass and

property value Model default.
• Property Identifier and property value ds_mode
setDataStore(cm,'mode','StorageClass','Model default','Identifier','ds_mode');

7 Verify your configuration changes by calling function getDataStore. Specify the object returned
by coder.mapping.api.get, the name of the data store, and property StorageClass or
Identifier.

getDataStore(cm,'mode','StorageClass')

ans =

    'Model default'

getDataStore(cm,'mode','Identifier')

ans =

    'ds_mode'
8 Save the model.
9 Generate and view the code. For example, in rtwdemo_configinterface.c, find the data

definition for the data store.
static boolean_T ds_mode;

Find where the data store is used in the step entry-point function.
.
.
.
  ds_mode = ((input1 > rtwdemo_configinterface_UPPER) || (input1 <
              rtwdemo_configinterface_LOWER));
.
.
.
  if (ds_mode) {
    output = (real_T)mp_K1 * dout_Table1;
  } else {
    output = dstate_X;
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  }
.
.
.

Choose Storage Class and Storage Class Properties for Data Stores
Depending on your code generation requirements, choose from these storage classes to configure
code generation for data stores.

Requirements Storage Class
Enable optimizations, potentially generating more efficient
code.

“Auto” on page 34-76 (Individual
mappings only)

For data elements that cannot be optimized, represent data
as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping only)

Prevent optimizations from eliminating storage for a data
element and use the default storage class for the data
element category.

“Model Default” on page 34-76
(Individual mappings only) ,
Dictionary Default (Individual
mappings only)

Generate a structure that stores Boolean data in named
bitfields.

“Bitfield” on page 34-77 (Individual
mapping only)

Generate a global variable definition and declaration that
has the volatile type qualifier.

Volatile (See “Const, Volatile, and
ConstVolatile” on page 34-78)

Generate a global variable definition and declaration. “ExportedGlobal” on page 34-77
Generate a global variable definition and declaration to a
specified file.

“ExportToFile” on page 34-79

Generate a global variable definition and declaration that
has the static type qualifier.

“FileScope” on page 34-80 (Local and
shared local data store mappings only)

Generate code that interacts with data by calling your
custom accessor functions.

“GetSet” on page 34-80

Generate code that reads from and writes to a global
variable or global variable pointer defined by your external
code.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

Generate code that reads from and writes to a global
variable defined by your external header file.

“ImportFromFile” on page 34-80

Generate variables that are local to functions. “Localizable” on page 34-81
Generate a global structure that has a name, which you can
specify.

“Struct” on page 34-82 (Individual
mappings only)

The list of available storage classes might include other project-specific storage classes defined in an
Embedded Coder Dictionary. If you have special requirements that are not met by the listed storage
classes and you have Embedded Coder software, you can define a storage class. See “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2.

For an individual data store, use the Identifier storage class property to configure a name for the
variable representing the data store in the generated code. With Embedded Coder, depending on the
storage class that you choose, you can also configure these properties.
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Property Description Storage Classes
DefinitionFile Source definition file that contains

definitions for global data, which is read
by the data store and external code

ExportToFile and
Volatile

GetFunction Data store appears in the generated code
as a call to a specified get function

GetSet

HeaderFile Source header file that contains
declarations for global data, which is read
by the data store and external code

ExportToFile, GetSet,
ImportFromFile, and
Volatile

Memory Section
(default data store
configuration only)

Memory section that contains data read by
the data store

Default

Owner Code generator places the definition for
data stores in the code generated for one
of multiple models in a model hierarchy
that share definitions. You must select the
model configuration parameter Use
owner from data object for data
definition placement. See “Control
Placement of Global Data Definitions and
Declarations in Generated Files” on page
35-2.

ExportToFile and
Volatile

PreserveDimensions Code generator preserves dimensions of
data stores that are represented in
generated code as a multidimensional
array. You must set the model
configuration parameter Array layout to
Row-major. See “Preserve Dimensions of
Multidimensional Arrays in Generated
Code” on page 45-2.

ExportToFile, FileScope,
ImportFromFile,
Localizable and Volatile

SetFunction Data store appears in the generated code
as a call to a specified set function.

GetSet

StructName Name for a structure in the generated
code for the data store.

BitField and Struct

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Manage Multiple Code Mappings for a Model
Code mappings separate code generation configurations from model designs. This separation enables
you to design models that are platform-neutral and ready to deploy to different run-time
environments. If you have access to the necessary products, you can associate a model with code
mappings for several different platforms.

Platform System Target File Programming
Language

Required Products

C rapid prototyping GRT-based C Simulink Coder
C production ERT-based C Embedded Coder
AUTOSAR classic AUTOSAR C AUTOSAR Blockset,

Embedded Coder (for
generating code)

AUTOSAR adaptive AUTOSAR Adaptive C++ AUTOSAR Blockset,
Embedded Coder (for
generating code)

You can generate code for the different platforms from a model or model hierarchy. Associate the
models in a model hierarchy with the same platform.

Simulink activates an existing code mapping when you do one of the following:

• In the Simulink Editor, open a coder app for a model and specify an output type that supports code
mappings.

• Use the code mappings API to create a code mapping.

The Code Mappings editor and code mappings programming interface display and operate on the
active code mapping.

Configure Alternative Code Mappings by Using Configuration Sets
You can configure alternative code mappings for a model by creating multiple model configuration
sets and changing which configuration set is active. Simulink creates or opens an existing code
mapping for a model based on settings of these model configuration parameters:

• System target file
• Language
• Code interface packaging

Create a configuration set for each platform for which you want to generate code for a model. Code
mappings are supported for these combinations of parameter settings.

Platform System target file Language Code interface
packaging

C rapid prototyping grt.tlc or derivative
of grt.tlc

C Nonreusable
function or Reusable
function
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Platform System target file Language Code interface
packaging

C production ert.tlc or derivative
of ert.tlc

C Nonreusable
function or Reusable
function

AUTOSAR classic autosar.tlc C Nonreusable
function or Reusable
function

AUTOSAR adaptive autosar_adaptive.t
lc

C++ C++ class

Activate the configuration set of interest. Then, open the corresponding code mappings in the
Simulink Editor, as described in “Activate Code Mappings in the Simulink Editor” on page 33-93 or
the code mappings API in “Create and Activate Code Mappings Programmatically” on page 33-93.

Activate Code Mappings in the Simulink Editor
When you open a model in the Simulink Editor, Simulink activates an existing code mapping for the
model based on settings of these model configuration parameters:

• System target file
• Language
• Code interface packaging

When you open one of the following coder apps, Simulink checks whether the system target file
setting of the active configuration set aligns with your coder app selection, which can be one of these:

• Simulink Coder (GRT-based system target file)
• Embedded Coder (ERT-based system target file)
• AUTOSAR Component Designer (AUTOSAR system target file)

When Simulink detects a misalignment, the editor displays a message that identifies the current
system target file setting and questions whether you want to change it and open the selected coder
app. You can cancel the operation and open the app that aligns with the current system target file
setting or continue with changing the system target file and open the app that you selected.

If the current system target file aligns with your coder app selection, Simulink opens the coder app
and adds a code tab (for example, C Code or AUTOSAR) to the editor toolstrip.

After a coder app opens, on the toolstrip, for Output, select the C code setting or, for AUTOSAR,
select one of the AUTOSAR platforms. Then, use the Code Interface menu to open the Code
Mappings editor.

Create and Activate Code Mappings Programmatically
You can use the code mappings functions coder.mapping.utils.create and
coder.mapping.api.get to create and activate code mappings for GRT- and ERT-based model
platforms.

1 Set up multiple model configuration set objects (Simulink.ConfigSet) for the model. For
example, you might set up GRT and ERT C code configurations or two ERT code configurations,
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one for generating reusable functions and one for generating nonreusable function code. Name
the configuration sets and attach them to your model.

grtConfigObj = Simulink.ConfigSet;
set_param(grtConfigObj,'Name','grtConfig');
attachConfigSet('myModel',grtConfigObj);

ertConfigObj = Simulink.ConfigSet;
set_param(ertConfigObj,'Name','ertConfig');
attachConfigSet('myModel',ertConfigObj);

2 Activate and create a code mapping for one of the configuration sets by calling
setActiveConfigSet and coder.mapping.utils.create.

setActiveConfigSet('myModel','grtConfig');
grt_cm = coder.mapping.utils.create('myModel');

3 Activate and create a code mapping for the second configuration set.

setActiveConfigSet('myModel','ertConfig')
ert_cm = coder.mapping.utils.create('myModel');

4 Activate the model code mappings by using calls to coder.mapping.api.get that specify the
code mapping type, SimulinkCoderC or EmbeddedCoderC.

grt_cm = coder.mapping.api.get('myModel','SimulinkCoderC');
.
.
.
# Configure model data elements
.
.
..
ert_cm = coder.mapping.api.get('myModel','EmbeddedCoderC');

Code Mappings and Embedded Coder Dictionary
If you have Embedded Coder, you can use the Embedded Coder Dictionary to generate standardized
code from multiple models. Because the definitions in the Embedded Coder Dictionary for a model
are separate from your model elements, you can share the definitions by storing the Embedded Coder
Dictionary in a Simulink data dictionary outside of your model. See “Separation of Code Definitions
from Model-Specific Data and Function Configurations” on page 31-31.

See Also
Code Mappings editor | Simulink.ConfigSet | coder.mapping.api.CodeMapping |
setActiveConfigSet

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Manage Configuration Sets for a Model”
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Configure Model Data Interface for C Code Generation
To integrate the generated code with external code or to generate code that complies with coding
standards and guidelines, you can configure how data elements in a model, such as block parameters
and signals lines, appear in the generated code. You can configure default code generation settings
for categories of data elements and configure individual elements by using the Code Mappings editor
or code mappings API. For example, you can configure settings that:

• Control placement of declarations and definitions in generated and external (exported and
imported) files.

• Package multiple data items into structures.
• Apply storage type qualifiers const and volatile.

This example shows how to configure data elements for code generation for example model
rtwdemo_configinterface.

Explore Example Model

Open example model rtwdemo_configinterface.

model = 'rtwdemo_configinterface';
open_system(model)

The example shows how to configure these model data elements for code generation:

• Inport blocks In1, In2, In3, and In4
• Outport block Out1
• Model parameter arguments LOWER and UPPER
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• Model parameters K1, Table1, and Table2
• Local data store mode
• Signal lines sourced from lookup table blocks Table1 and Table2
• State X (delay)

Configure Default Settings for Inport Blocks

1 Open the Embedded Coder app.
2 In the C Code tab, select Code Interface > Default Code Mappings.
3 In the Code Mappings editor, under Inports and Outports, select category Inports. Set the

default storage class to ImportFromFile.
4 In the Property Inspector, set Header File to exInDataLut.h.

Configure Default Settings for Outport Block

1 On the Data Defaults tab, under Inports and Outports, select category Outports. Set the
default storage class to ExportToFile.

2 In the Property Inspector, set Header File to exOutSys.h and Definition File to exOutSys.c.

Configure Default Settings for Parameters

1 On the Data Defaults tab, under Parameters, select category Model parameter arguments.
Leave the storage class set to Default. With that setting, the code generator allocates a
separate area of memory for each argument instance.

2 Select category Model parameters. Link text 'Auto' will be inlined indicates that the
code generator is configured to inline model parameters by default. For this example, configure
the model parameters to be tunable. Click 'Auto' will be inlined. The Model
Configuration Parameters dialog box opens.

3 Set model configuration parameter Default parameter behavior to Tunable. Save the change
and close the dialog box. In the Code Mappings editor, the link text changes to 'Auto' will be
tunable.

4 In the Code Mappings editor, with the Model parameters category selected, set the storage
class to ConstVolatile.

Configure Default Settings for Signals, States, and Data Stores

1 On the Data Defaults tab, under Signals, select category Signals,states, and internal data.
Set the default storage class to FileScope.

2 Configure default code mappings for shared local data stores. Select category Shared local data
stores. Set the storage class to Volatile.

3 Save the model.

Configure Code Generation Settings for Individual Inport Blocks

1 In the Code Mappings editor, click the Inports tab. The editor lists the names of root-level
Inport and In Bus Element blocks that are in the model. If a port resolves to a signal object,
a resolve-to-signal-object icon appears to the right of the element name. The storage class for
each inport is set to Auto, which means that the code generator might eliminate relevant code
for optimization purposes. If optimizations are not possible, the code generator applies the model
default configuration. For this example, the model default configuration specifies storage class
ImportedFromFile. To avoid avoid optimizations and force the code generator to use the
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default configuration, set the storage class to Model default. To override the default
configuration, specify the storage class that meets the code generation requirements for that
inport.

2 Configure the code generator to apply the default storage class setting to inports In2, In3, and
In4. Select the rows for the three inports. Then, for one of the selected inports, set the storage
class to Model default: ImportFromFile. The storage class for the three selected inports
changes to Model default: ImportFromFile.

3 For inport In1, override the default storage class setting. Set the storage class to
ImportFromFile. In the Property Inspector, set Header File to exInDataMem.h.

4 Configure code identifiers for the inports so that the variables in the generated code match the
interface names in the external header and definition files. In the Code Mappings editor, select
the row for each inport. In the Property Inspector, set the Identifier property to these values:
input1, input2, input3, and input4.

Configure Code Generation Settings for Individual Outport Blocks

1 In the Code Mappings editor, click the Outports tab. The editor lists the names of root-level
Outport and Out Bus Element blocks that are in the model. If a port resolves to a signal
object, a resolve-to-signal-object icon appears to the right of the element name. The storage class
for the outport in the example model is set to Auto, which means that the code generator might
eliminate relevant code for optimization purposes.

2 To avoid optimizations and force the code generator to use the default configuration, set the
storage class to Model default: ExportToFile. The storage class for the selected outport
changes to Model default: ExportToFile.

3 Configure the code identifier for the outport so that the variable in the generated code matches
the interface name used by the external code. In the Code Mappings editor, select the row for the
outport. In the Property Inspector, set the Identifier property to output.

Configure Code Generation Settings for Individual Parameters

1 In the Code Mappings editor, click the Parameters tab. Expand Model Parameter Arguments.
By default, the storage class for each model parameter argument is set to Auto, which means
that the code generator might eliminate relevant code for optimization purposes. If optimizations
are not possible, the code generator applies the model default configuration. For this example,
leave the storage class set to Auto.

2 Expand Model Parameters. By default, the storage class for each model parameter is set to
Auto. For this example, you want to avoid optimizations and for the code generator to use the
default storage class setting, ConstVolatile.

3 In the Code Mappings editor, under Model Parameters, select parameters K1, Table1, and
Table2. Set the storage class to Model default: ConstVolatile.

4 Configure the code identifiers for model parameters with names that include the prefix mp_, as
the requirements specify. In the Code Mappings editor, select model parameter K1. In the
Property Inspector, expand the Code node. Set the storage class property Identifier to mp_K1.
For parameters Table1 and Table2, set Identifier to mp_Table1 and mp_Table2.

Configure Code Generation Settings for Individual Data Stores

1 In the Code Mappings editor, click the Data Stores tab. Expand Local Data Stores. The storage
class for data store mode is set to Auto, which means that the code generator might eliminate
relevant code for optimization purposes. For this example, you want to avoid optimizations and
for the code generator to use the default storage class setting, Volatile.
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2 In the Code Mappings editor, select local data store mode. Set the storage class to Model
default: Volatile.

3 Configure the code identifier for the data store with a name that includes the prefix ds_. In the
Code Mappings editor, select shared local data store mode. In the Property Inspector, expand the
Code node. Set the storage class property Identifier to ds_mode.

Configure Code Generation Settings for Individual States

1 In the Code Mappings editor, click the Signals/States tab. Expand States. The storage class for
the state is set to Auto, which means that the code generator might eliminate relevant code for
optimization purposes. For this example, you want to avoid optimizations and for the code
generator to use the default storage class setting, FileScope.

2 In the Code Mappings editor, select state X. Set the storage class to Model default:
FileScope.

3 Configure the code identifier for the state with a name that includes the prefix dstate_, as the
requirements specify. In the Code Mappings editor, select state X. In the Property Inspector,
expand the Code node. Then, set the storage class property Identifier to dstate_X.

Configure Code Generation Settings for Individual Signals

Add signals that you want to configure to the model code mappings. For this example, add to the
model code mappings the output signals for the two lookup table blocks. Then, configure those
signals.

1 In the Code Mappings editor, click the Signals/States tab. No signals are listed.
2 Add signals to the code mappings. For the output signals of lookup table blocks Table1 and

Table2, in the model, select a signal, pause on the ellipsis that appears above or below the
signal line to open the action bar, and click the Add Signal button. In the Code Mappings editor,
the Signals node expands and lists the names or block identifiers of the two signals that you
added. If a signal resolves to a signal object, a resolve-to-signal-object icon appears to the right
of the element name or port identifier. The storage class for each signal is set to Auto, which
means that the code generator might eliminate relevant code for optimization purposes. For this
example, you want to avoid optimizations and for the code generator to use the default storage
class setting, FileScope.

3 In the Code Mappings editor, select the output signals for blocks Table1 and Table2. Set the
storage class to Model default: FileScope.

4 Configure the code identifier for the output signals for the two lookup table blocks with names
that include the prefix dout. In the Code Mappings editor, select signal Table1:1. In the
Property Inspector, expand the Code node. Set the storage class property Identifier to
dout_Table1. For signal Table2:1, set Identifier to dout_Table2.

5 Save the model.

Configure Data for Code Generation Programmatically

Alternatively, use the code mappings API to configure model data elements programmatically.

1. Get the object that represents the code mappings for the model by calling
coder.mapping.api.get. You specify the returned object as the first argument in subsequent calls
to code mapping functions.

cm = coder.mapping.api.get(model);
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2. Configure default code generation settings for categories of data elements with calls to
setDataDefaults. In each call, include the object returned by the call to
coder.mapping.api.get, the name of a data element category, and name-value pair arguments
that specify the storage class and storage class properties. Use setDataDefaults to configure
these default settings:

• Inport blocks with storage class ImportFromFile and header file exInDataLut.h
• Outport blocks with storage class ExportToFile and header file exOutSys.h and definition file

exOutSys.c
• Model parameter arguments with the code generator default configuration
• Model parameters with storage class ConstVolatile
• Internal data (signals, states, and local data stores) with storage class FileScope
• Shared locoal data stores with storage class Volatile

setDataDefault(cm,'Inports','StorageClass','ImportFromFile','HeaderFile','exInDataLut.h');
setDataDefault(cm,'Outports','StorageClass','ExportToFile','HeaderFile','exOutSys.h',...
'DefinitionFile','exOutSys.c');
setDataDefault(cm,'ModelParameterArguments','StorageClass','Default');
setDataDefault(cm,'ModelParameters','StorageClass','ConstVolatile');
setDataDefault(cm,'InternalData','StorageClass','FileScope');
setDataDefault(cm,'SharedLocalDataStore','StorageClass','Volatile');

Set model configuration parameter DefaultParameterBehavior to Tunable, so that model
parameters are accessible during program exeuction.

set_param(model,'DefaultParameterBehavior','Tunable');

3. Configure individual Inport blocks with calls to setInport. To avoid optimizations, apply the
default configuration for Inport blocks to In2, In3, and In4. For In1, override the default
configuration, by setting the storage class to ImportFromFile and the header file to
exInDataMem.h. Also, configure code identifiers for the inports so that the global variables that
represent inports in the generated code match the variable names in the external definition file. In
each call to setInport, specify the object returned by coder.mapping.api.get, the Inport
block name, and name-value pair arguments for storage class and property settings.

setInport(cm,'In1','StorageClass','ImportFromFile','HeaderFile','exInDataMem.h',...
    'Identifier','Input1');
setInport(cm,'In2','StorageClass','Model default','Identifier','Input2');
setInport(cm,'In3','StorageClass','Model default','Identifier','Input3');
setInport(cm,'In4','StorageClass','Model default','Identifier','Input4');

4. Configure individual data element settings for Outport block Out1 with a call to setOutport.To
avoid optimizations, apply the default configuration. Also, configure a code identifer for the outport.
In the call to setOutport, specify the object returned by coder.mapping.api.get, the Outport
block name, and name-value pair arguments for the storage class and code identifer property
settings.

setOutport(cm,'Out1','StorageClass','Model default','Identifier','output');

5. Configure individual model parameters with calls to setModelParameter.To avoid optimizations,
apply the default configuration. Also, configure code identifers for the parameters. In each call to
setModelParameter, specify the object returned by coder.mapping.api.get, the parameter
name, and name-value pair arguments for the storage class and code identifer property settings.
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setModelParameter(cm,'K1','StorageClass','Model default','Identifier','mp_K1');
setModelParameter(cm,'Table1','StorageClass','Model default','Identifier','mp_Table1');
setModelParameter(cm,'Table2','StorageClass','Model default','Identifier','mp_Table2');

6. Configure individual data element settings for local data store mode with a call to
setDataStore.To avoid optimizations, apply the default configuration. Also, configure a code
identifer for the data store. In the call to setDataStore, specify the object returned by
coder.mapping.api.get, the data store name, and name-value pair arguments for the storage
class and code identifer property settings.

setDataStore(cm,'mode','StorageClass','Model default','Identifier','ds_mode');

7. Configure individual data element settings for state X with a call to setState.To avoid
optimizations, apply the default configuration. Also, configure a code identifer for the state. In the
call to setState, specify the object returned by coder.mapping.api.get, the path for the block
that uses the state, and name-value pair arguments for the storage class and code identifer property
settings.

setState(cm,'rtwdemo_configinterface/Delay','StorageClass','Model default',...
    'Identifier','dstate_X');

8. Add signals to the code mappings and configure them with calls to setSignal.To add the port
handles to add the signal data to the model code mappings with calls to get_param. Then, specify
the block handles in a call to addSignals. To avoid optimizations, apply your default configuration
for signals. Also, configure code identifers for the signals. In each call to setSignal, specify the
object returned by coder.mapping.api.get, the path or block handle of the signal source, and
name-value pair arguments for the storage class and code identifer property settings.

lut1D_ports = get_param('rtwdemo_configinterface/Table1','PortHandles');
lut2D_ports = get_param('rtwdemo_configinterface/Table2','PortHandles');

lut1D_outPort = lut1D_ports.Outport;
lut2D_outPort = lut2D_ports.Outport;

addSignal(cm,[lut1D_outPort,lut2D_outPort]);

setSignal(cm,lut1D_outPort,'StorageClass','Model default','Identifier','dout_Table1');
setSignal(cm,lut2D_outPort,'StorageClass','Model default','Identifier','dout_Table2');

Generate and View Code

1. Generate code.

slbuild(model)

### Starting build procedure for: rtwdemo_configinterface
### Successful completion of code generation for: rtwdemo_configinterface

Build Summary

Top model targets built:

Model                    Action          Rebuild Reason                                    
===========================================================================================
rtwdemo_configinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 17.134s
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2. View the code. For example, in rtwdemo_configinterface.c, find where these variables are used in
the step entry-point function: input1, input2, input3, input4, output, mp_K1, ds_mode,
dstate_X, dout_Table1, and dout_Table2.

Related Topics

• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Configure Root-Level Inport Blocks for C Code Generation” on page 33-30
• “Configure Root-Level Outport Blocks for C Code Generation” on page 33-42
• “Configure Signal Data for C Code Generation” on page 33-51
• “Configure Parameters for C Code Generation” on page 33-62
• “Configure Block States for C Code Generation” on page 33-75
• “Configure Data Stores for C Code Generation” on page 33-83
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• Code Mappings Editor – C
• Embedded Coder Dictionary
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Migration of Model Data Configurations to Code Mappings
Starting in R2020b, the recommended approach to configure model data for code generation is to use
the Code Mappings editor or code mappings API. From one interface, you can configure default
settings for categories of data, and then override those settings, as needed, for specific data
elements. For parameters, you can specify whether they are inlined or tunable by default. When
producing code for data, the code generator uses the code definitions that you specify to determine
how to represent the data in the generated code.

When you open a model created in a release before R2020b, Simulink migrates code definitions
specified in the model to the model code mappings.

If necessary, as part of the migration, Simulink configures the Embedded Coder Dictionary that the
model uses. When you save the model, the code mappings are saved as part of the model.

Effects of Migration
For data configured within a model, the migration process replaces existing storage class
specifications with equivalent code mappings. Data configured for code generation within a model
includes data represented by:

• Outport blocks
• Signal lines
• Block states
• Data stores
• Parameter objects in the model workspace

This table lists specific model conditions and their corresponding migration results.

Condition Migration Results
Model is a library model or a model configured
with an AUTOSAR system target file.

Simulink discards the code configuration
associated with data configured within the model.

Data element is configured for code generation
within the model and the data element is
associated with a Simulink.CoderInfo object,
the StorageClass property for that object is set
to Custom, and the CustomStorageClass
property is set to Default.

Simulink changes the storage class setting from
Custom (Default) to ExportedGlobal and
displays a warning.
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Condition Migration Results
Model uses data objects configured for use with
the TypeQualifier storage class property for a
built-in storage class, such as ExportedGlobal
or ImportedExtern. You might have set the
property as:

• CoderInfo.TypeQualifier property for
data objects in a workspace or data dictionary

• Port parameter RTWStorageTypeQualifier
• Block parameter

RTWStateStorageTypeQualifier for Data
Store Memory, Discrete Filter, Discrete State-
Space, Discrete-Time Integrator, Discrete
Transfer Fcn, Discrete Zero-Pole, and Memory
blocks

Simulink issues a warning indicating that the
property is no longer supported. Other interfaces
are available for achieving the same results.

Model uses the Simulink.CoderInfo object
Alignment property for data configured within
the model.

Simulink issues a warning indicating that the
property is no longer supported for model-
specific data. You can use the property for data
stored in the base workspace or a data dictionary.

You initialize the model workspace for the model
from an external data source, such as a MAT-file,
MATLAB file, or data dictionary.

Simulink moves code configuration for the
parameter object to the code mappings for that
model.

For an individual subsystem from which you
generate code and executable programs by right-
clicking the Subsystem block, you configure the
storage class and storage class properties for the
subsystem input and output signals outside of the
subsystem.

Generated code does not include variables for the
input and output interface data.

If you perform these operations, you might need to take action:

• Use the Simulink Editor to copy a block line to another model. Simulink does not copy the code
configuration information associated with the copied modeling element. For more information, see
“Copy Blocks and Signal Lines Between Models” on page 33-106.

• Switch the system target file setting for a model between a GRT-based and ERT-based system
target file. Simulink ignores the code configuration information for the system target file of the
source version of the copied model. For more information, see “Switch Between GRT- and ERT-
Based System Target Files” on page 33-107.

Considerations Before Migrating
Before migration, consider the preparation suggested in the following sections if these conditions
exist:

• Data configured within a library or AUTOSAR model
• Storage class TypeQualifier property
• Data alignment for code generation
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• Code configuration for parameter objects initialized in the model workspace
• Code configuration for subsystem I/O interface

Data Configured Within Library or AUTOSAR Model

If your model is a library model or a model configured with an AUTOSAR system target file,
reconfigure code generation for data. For library models, reconfigure code generation for data in the
context of models that use the library (see “C Data and Function Configuration”). For AUTOSAR
models, see “Map AUTOSAR Elements for Code Generation” (AUTOSAR Blockset).

To avoid losing the code configuration for data configured within the model, in an earlier release, load
the model and create and run a MATLAB script that:

1 Loads the model data.
2 Finds data configured for code generation within the model.
3 Converts the representation of the data to data objects that you store in an external source, such

as a MAT-file, MATLAB file, or data dictionary.
4 Updates the model to use the external data objects.

Storage Class TypeQualifier Property

If your model configures data objects with built-in storage classes, such as ExportedGlobal and
ImportedExtern, and uses the storage class TypeQualifier property, when you load the model in
release R2020b or later, Simulink issues a warning. To eliminate the warning and update a model to
use a supported alternative, in an earlier release, load the model and create and run a MATLAB script
that:

1 Loads the model data objects from the model workspace, base workspace, or data dictionary.
2 Finds data objects with the TypeQualifier property set to a non-empty string value.
3 Changes the storage class setting to a storage class predefined with the required type qualifier

(for example, storage class Const includes qualifier const in data declarations and definitions).

This example script loads model data objects from the base workspace, finds instances of data
configured with the storage class TypeQualifier property, and changes the storage class setting to
Const.
vars = who;

  for idx = 1:length(vars)
    thisVar = evalin('base',vars{idx});
    if (isa(thisVar,'Simulink.Parameter') && (isequal(thisVar.CoderInfo.TypeQualifier, 'const')))
      thisVar.CoderInfo.TypeQualifier = '';
      thisVar.CoderInfo.StorageClass = 'Custom';
      thisVar.CoderInfo.CustomStorageClass = 'Const';
    end
  end

Starting in R2020b, to include type qualifiers in the generated code, use the Code Mappings editor or
code mappings API to associate data with a storage class that specifies use of the const or
volatile keyword (see “Choose Storage Class for Controlling Data Representation in Generated
Code” on page 34-74). If none of the available storage classes meets your application requirements
and you are using Embedded Coder, define a new storage class by using the Embedded Coder
Dictionary (see “Define Storage Classes, Memory Sections, and Function Templates for Software
Architecture” on page 31-2). Then, map the model data to the new storage class.
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Data Alignment for Code Generation

To preserve data alignment information configured for a model, represent data with data objects
outside of the model. For example, open the model in a previous release of Simulink and perform the
actions listed in this table.

Type of Data Element Action
Parameter object in the model workspace Use the Model Explorer to move the object from

the model workspace to the base workspace or a
data dictionary. Then, set the storage class and
alignment properties of the object. Save the
model.

Signal line Open the Signal Properties dialog box, specify a
name for the signal and select Must resolve to
signal object (storage class must be Auto).
Create a Simulink.Signal object in the base
workspace or a data dictionary and set the
storage class and alignment properties of the
object. Save the model.

Block state Open the Block Parameters dialog box, specify a
name for the state and select State must
resolve to signal object (storage class must be
Auto). Create a Simulink.Signal object in the
base workspace or a data dictionary and set the
storage class and alignment properties. Save the
model.

Alternatively, create and run a MATLAB script that:

1 Loads the model data.
2 Finds data objects that set Simulink.CoderInfo.Alignment.
3 Converts the representation of the data to data objects that you store in an external source, such

as a MAT-file, MATLAB file, or data dictionary.
4 Sets Simulink.CoderInfo object property Alignment for the new data objects.

For example, this script checks whether Alignment is set for parameter, lookup table, and
breakpoint data objects and captures the data objects found in MAT-file savedData.mat.
filename = 'savedData.mat';
varList = who;
tosaveVars = {};
for idx = 1 : length(varList)
   variable = eval(varList{idx});
   if ((isa(variable, 'Simulink.Parameter') || ...
       isa(variable, 'Simulink.LookupTable') || ...
       isa(variable, 'Simulink.Breakpoint')) && ...
       variable.CoderInfo.Alignment ~= -1)
       tosaveVars{end+1} = varList{idx};       
   end
end
if ~isempty(tosaveVars)
  save('savedData.mat', tosaveVars{:});
end

Evaluate the script in the model workspace with these commands:

mws = get_param(bdroot, 'ModelWorkspace');
evalin(mws, 'SaveMWSParamsWithAlignment');
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For parameter objects in the model workspace, alternatively, you can use the Model Explorer
interface to move the objects from the model workspace to the base workspace or a data dictionary.
Then, select the Alignment property for the storage class.

Code Configuration for Parameter Objects Initialized in Model Workspace

After loading a model in release R2020b or later and initializing the model workspace for the model
from an external data source, such as a MAT-file, MATLAB file, or data dictionary, Simulink:

• Saves the contents of the Simulink.CoderInfo object to the model code mappings.
• Removes the Simulink.CoderInfo object from the Simulink.Parameter object defined in the

external data source.

Use the Code Mappings editor or the code mappings API to get and set parameter code configuration
settings. See “C Data and Function Configuration”.

Code Configuration for Subsystem I/O Interface

In release R2020b or later, for individual subsystems from which you generate code and executable
programs by right-clicking the Subsystem block, to include signal data in the generated subsystem
code interface, configure the storage class and storage class properties for the subsystem input and
output signals within the subsystem. If you configure the signals outside of the subsystem, the
generated code does not include variables for the input and output interface data.

For more information, see “Generate Code and Executables for Individual Subsystems” on page 3-5.

Copy Blocks and Signal Lines Between Models
Starting in R2020b, when you use the Simulink Editor to copy a block or signal line to another model,
Simulink does not copy the code configuration information associated with the copied modeling
element.

To work around this change, copy and paste the code configuration information for data elements by
using the code mappings API.

1 Open the source and destination models for the copy operation.
2 Use the code mappings API to get the code mappings object for the source model.
3 Use the code mappings API to get code mapping information for the model element that you are

copying.
4 If a code mappings object does not exist for the destination model, use the code mappings API to

create one.
5 For the model element that you are copying to the destination model, use the code mappings API

to set code mapping information to the same values as for the source model.
6 Close the source model.
7 Save and close the destination model.

For example:
.
.
.
srcMdl = 'my_src_mdl';
destMdl = 'my_dest_mdl';
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open_system(srcMdl);
open_system(destMdl);

% Get data configuration from source model
srcCM = coder.mapping.api.get(srcMdl);
srcSC = getSignal(srcCM, srcPort, 'StorageClass')

% Set data configuration for destination model to setting of source model
destCM = coder.mapping.api.get(destMdl);
setSignal(destCM, destPort, 'StorageClass', srcSC);

close_system(srcMdl);
save_system(destMdl);
close_system(destMdl);
.
.
.

Switch Between GRT- and ERT-Based System Target Files
Starting in R2020b, when you switch the system target file setting for a model between a GRT-based
and ERT-based system target file, Simulink applies alternative code configurations for each system
target file. This switch can occur if you:

• Alternate between the Simulink Coder and Embedded Coder apps.
• Change the active configuration set for a model.
• Change the setting of model configuration parameter System target file.

To preserve the code configuration information for data configured within the model, create and run a
MATLAB script that uses the code mappings API to copy relevant code mappings.

1 Open the model with the source system target file and code mappings that you want to preserve.
2 Use the code mappings API to get the code mappings object for the model and get data mappings

objects for the data elements.
3 Use the code mappings API to get the code mappings object for the model and set data mappings

objects for the data elements.
4 Save and close the model.

This script fragment shows how to use the code mappings API to preserve the storage class of a
signal object when switching from a GRT system target file to a an ERT system target file.

.

.

.
mymdl = 'my_shared_mdl';

open_system(mymdl);

% Get data configuration for Simulink Coder (GRT-based) code generation
scCodeMapping = coder.mapping.api.get(model, 'SimulinkCoderC'); 
scStorageClass = getSignal(scCodeMapping, srcPort, 'StorageClass') 

% Set data configuration for Embedded Coder (ERT-based) code generation
ecCodeMapping = coder.mapping.api.get(model, 'EmbeddedCoderC'); 
setSignal(ecCodeMapping, srcPort, 'StorageClass', scStorageClass)

save_system(mymdl);
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close_system(mymdl);

.

.

.

Workflow Changes
Starting in R2020b, configure model data elements for code generation by using the Code Mappings
editor or code mappings API instead of or in addition to creating and configuring Simulink data
objects. Use this workflow:

1 Open the Embedded Coder app.
2 In the Code Mappings editor, configure default behavior for storage representation. This

capability was introduced in R2018a. See “Configure Default C Code Generation for Categories
of Data Elements and Functions” on page 33-15..

3 Decide whether to override default configuration settings for individual data elements. If you
choose not to override settings, skip to step 8.

4 Identify MATLAB variables that you want to configure individually and store the configurations in
the model workspace. In the Model Explorer, convert the variables to Simulink.Parameter
objects. The resulting data objects appear in the Code Mappings editor as model parameters.

5 Identify signals representing algorithm data that you want to monitor while the generated code
executes and configure individually. For each signal that you identify, do one of the following:

• For signal data that is specific to a model (not shared), add the signals to the Code Mappings
editor. In the model, pause on the ellipsis above a signal line to open the action bar. Click the
Add Signal button to add the signal to the Code Mappings editor.

• For shared signal data, create and configure Simulink.Signal objects. See “C Code
Generation Configuration for Model Interface Elements” on page 33-2 and “Control Signal
and State Initialization in the Generated Code” on page 34-174.

6 Configure individual data elements. In the Code Mappings editor, click a category tab, select a
data element, and set the storage class. In the Property Inspector, set storage class property
values. To change the setting of model configuration parameter Default parameter behavior
click the link indicating the behavior when the storage class is set to Auto. In the Model
Configuration Parameters dialog box, change the parameter setting to Tunable or Inline.

7 To view external data objects that are stored in the base workspace or a data dictionary, in the
Code Mappings editor, click the Code Mappings editor Refresh button.

8 Generate and review code.

See Also

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “Control Data and Function Interface in Generated Code” on page 34-44
• “Control Signal and State Initialization in the Generated Code” on page 34-174
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Dimension Preservation of Multidimensional Arrays

Dimension Preservation in Generated Code
The code generator produces one-dimensional arrays in the C/C++ code for multidimensional model
data. For example, consider matrix matrixParam.

matrixParam = 
        1        2        3
        4        5        6

By default, MATLAB stores data in column-major format. The code generator defines matrix
matrixParam in the generated code as:

/* const_params.c */
matrixParam[6] = {1, 4, 2, 5, 3, 6};

The code generator initializes matrix matrixParam in the generated code as:

/* model.c */
extern const real_T matrixParam[6];

for(int i = 0; i < 6; i++) {
    ... = matrixParamValue[i];
}

When you set the model configuration parameter Array layout to Row-major, you can preserve
dimensions of multidimensional arrays in the generated code. Preserving array dimensions in
generated code enhances integration with external code.

For example, in row-major array layout, the code generator preserves the array dimensions in type
definition in the generated code as:

/* const_params.c */
const real_T matrixParam[2][3] = {{1, 2, 3}, {4, 5, 6}};

The code for initializing the multidimensional data is nested as:

/* model.c */
extern const real_T matrixParam[2][3];

for(int i = 0; i < 2; i++) {
    for (int j = 0; j < 3; j++) {
         ... = matrixParam[i][j];
    }
}

Difference in Dimension Preservation Between MATLAB and C
When you define a multidimensional array in the MATLAB Command Window, MATLAB stores the
array in column-major format. For example:
>> matrixParam.Value = [1 2 3; 4 5 6];  % Data inilitialized in row-major

>> matrixParam.Value                    % Data displayed in row-major
ans =
     1     2     3
     4     5     6

 Dimension Preservation of Multidimensional Arrays

33-109



>> matrixParam.Value(:)'                % Data stored in column-major
ans =
     1     4     2     5     3     6

Even if the data is initialized in row-major format in the MATLAB Command Window, MATLAB
serializes data in memory in column-major format.

When the code generator preserves dimensions, the generated code is:

real_T matrixParam[2][3] = { { 1.0, 2.0, 3.0 }, { 4.0, 5.0, 6.0 } } ;

For 2-D arrays, the index order and data definition are consistent with what you see in the MATLAB
Command Window and the generated code.

For n-D arrays, when the code generator produces row-major code and preserves array dimensions,
the index order is consistent with MATLAB. The data definition of n-D arrays in the generated code is
not consistent with the data displayed in the MATLAB Command Window. For example, consider that
matrixParam is a Simulink.Parameter:
>> matrixParam.Value = reshape(1:24,[4 3 2])      

>> matrixParam.Value                              
ans(:,:,1) =
     1     5     9
     2     6    10
     3     7    11
     4     8    12
ans(:,:,2) =
    13    17    21
    14    18    22
    15    19    23
    16    20    24

>> matrixParam.Value(:)'
ans =

  Columns 1 through 10

     1     2     3     4     5     6     7     8     9    10

  Columns 11 through 20

    11    12    13    14    15    16    17    18    19    20

  Columns 21 through 24

    21    22    23    24

In row-major array layout, the code generator preserves the array dimensions during type definition
in the generated code as:
/* const_params.c */
const real_T matrixParam[4][3][2] = { { { 1.0, 13.0 }, { 5.0, 17.0 }, { 9.0, 21.0 } },
  { { 2.0, 14.0 }, { 6.0, 18.0 }, { 10.0, 22.0 } }, { { 3.0, 15.0 }, { 7.0, 19.0
    }, { 11.0, 23.0 } }, { { 4.0, 16.0 }, { 8.0, 20.0 }, { 12.0, 24.0 } } };

The code for initializing the multidimensional data is nested as:

/* model.c */
extern const real_T matrixParam[4][3][2];

for (i = 0; i < 3; i++) {
    for (i_1 = 0; i_1 < 4; i_1++) {
      for (i_0 = 0; i_0 < 2; i_0++) {
        ... = ... + matrixParam[i_1][i][i_0];
      }
    }
  }
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See Also

Related Examples
• “Preserve Dimensions of Multidimensional Arrays in Generated Code” on page 45-2
• “Preserve Dimensions of Bus Elements in Generated Code” on page 45-7
• “Code Generation of Matrices and Arrays” on page 50-60
• “Select Array Layout for Matrices in Generated Code” (Stateflow)
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Configure C Code Generation for Model Entry-Point Functions

What Is an Entry-Point Function?
An entry point is a location in code where a transfer of program control (execution) occurs. The main
function (main()) is the entry point to a C/C++ program and is called when the application starts
executing. Calls to other functions, for example from the main function, provide entry points to
function code. Program control is transferred to the called function. The function code executes, and
when finished, returns control to the main or other calling function.

When producing code for a model, the code generator defines a set of entry-point functions that you
can call to execute the generated code. You can call the generated functions from external code or
from a version of the generated main function that you modify.

The Code Interface Report section of the code generation report lists the entry-point functions that
the code generator produces for a model. For more information, see “Analyze the Generated Code
Interface” on page 52-13.

Types of Generated Entry-Point Functions
The code generator produces entry-point functions for these types of model functions.

Type of Model
Function

Model Source Name Default Generated
Function Name

Description

Exported function
(requires
Embedded Coder)

ExportedFunction:sl
Identifier, where
slIdentifier is the
name of the function-call
Inport block in the model

function-call-inport-
block-name or signal-
label (if specified)

For an exported-
function model, the
exported function for a
subsystem.

Initialize function Initialize model_initialize Initialization code for a
model. At the start of
the application code,
call the function once.
Do not use this function
to reset the real-time
model data structure
(rtM).

Partition function Partition:slIdentif
ier, where
slIdentifier is a
partition that was
created explicitly from a
block in the model and
shown in the Simulink®
Schedule Editor (for
example, P1)

model_stepn, where n
uniquely identifies the
function generated for one of
the model sample periods

For a model partition,
output and update code.
Model configuration
parameter Single
output/update
function is selected
(the default).

33 Configuring Data and Functions in the Generated Code

33-112



Type of Model
Function

Model Source Name Default Generated
Function Name

Description

Partition update
function

PartitionUpdate:slI
dentifier, where
slIdentifier is a
partition that was
created explicitly from a
block in the model and
shown in the Simulink®
Schedule Editor (for
example, P1)

model_outputn and
model_updaten, where n
uniquely identifies the
function generated for one of
the model sample periods

For a model partition,
output and update code
in separate functions.
Model configuration
parameter Single
output/update
function is cleared.

Periodic
multitasking
function

Periodic:slIdentifi
er, where
slIdentifier is an
annotation that
corresponds to the
sample time period for a
periodic or continuous
rate of a multitasking
model (for example, D1)

model_stepn, where n
uniquely identifies the
function generated for one of
the model sample periods

For blocks in a rate-
based model configured
for multitasking, output
and update code. The
code generator
produces a function for
each sample period.
Model configuration
parameter Single
output/update
function is selected
(the default).

Periodic
multitasking
update function

PeriodicUpdate:slId
entifier, where
slIdentifier is an
annotation that
corresponds to the
sample time period for a
periodic or continuous
rate of a multitasking
model (for example, D1)

model_outputn and
model_updaten, where n
uniquely identifies the
function generated for one of
the model sample periods

For blocks in a rate-
based model configured
for multitasking, output
and update code in
separate functions. The
code generator
produces output and
update functions for
each sample period.
Model configuration
parameter Single
output/update
function is cleared.

Periodic single-
tasking function

Periodic model_step For blocks in a rate-
based model configured
for single-tasking,
output and update code.
Model configuration
parameter Single
output/update
function is selected
(the default).
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Type of Model
Function

Model Source Name Default Generated
Function Name

Description

Periodic single-
tasking update
function

PeriodicUpdate model_output and
model_update

For blocks in a rate-
based model configured
for single-tasking,
output and update code
in separate functions.
Model configuration
parameter Single
output/update
function is cleared.

Reset function Reset:slIdentifier,
where slIdentifier is
the name of the reset
function in the model

model_reset-function-
name

If the model includes a
Reset Function block,
reset code generated.
To reset conditions or
state, call the function
from the application
code.

Simulink Function Simulink
Function:slIdentifi
er, where
slIdentifier is the
name of the Simulink
Function block in the
model

function-name for a global
Simulink Function block or
model_function-name for
a scoped Simulink Function
block

For an exported-
function model, the
exported function for a
Simulink Function
block.

Terminate
function

Terminate model_terminate Code for turning off a
system. For ERT-based
models, you can
suppress generation of
this function by clearing
the model configuration
parameter Terminate
function required (set
by default).

If you have Embedded Coder software, to facilitate integration of external and generated code and
achieve compliance with code standards and guidelines, you can configure how the code generator
produces function interfaces from a model or subsystem.

Configure Whether Entry-Point Functions Are Reusable
By default, for top models, the code generator produces code that is not reusable or reentrant. Entry-
point functions have a void-void interface. Code communicates with other code by directly
accessing global data structures that reside in shared memory.

If your application requires reusable, multi-instance entry-point function code, you can configure the
code generator to call each function (instance) with unique data. In this case, the code is reentrant.

You configure whether entry-point functions are reusable with the model configuration parameter
Code interface packaging and related parameters. The parameter settings that you choose depend
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on factors such as configuration selections for the system target file, programming language, and
argument interface.

Default Configurations for Single-Instance C Entry-Point Functions

By default, for GRT- and ERT-based system target files, the code generator produces single-instance C
entry-point functions. The generated code:

• Creates an execution function without arguments (void-void).
• Allocates memory statically (at compile time) for model data structures.

The default model configuration parameter settings for configuring single-instance entry-point
function code are:

• Language set to C.
• Code interface packaging set to Nonreusable function.

Generate Reusable, Multi-Instance C Entry-Point Functions

You can configure the code generator to produce reusable entry-point functions in C for either a GRT-
or ERT-based system target file. However, the function interfaces that the code generator produces by
default varies. Assuming that model configuration parameter Language is set to C and Code
interface packaging is set to Reusable function, the code generator produces this entry-point
function code for each system target file scenario.

System Target File Interface
GRT-based • Reusable, multi-instance C entry-point functions that are reentrant.

• Packs values of model root-level Inport blocks and Outport blocks
into the real-time model data structure. Passes that structure to the
execution function as an argument by reference.

• Allocates memory dynamically at runtime for the data of a model
instance. Allocates the memory by calling a function, such as
malloc.

ERT-based • Reusable, multi-instance C entry-point functions that are reentrant.
• Passes the value of each model root-level Inport block and Outport

block to the execution function as a separate argument.
• Allocates memory statically for model data structures.

If you are using an ERT-based system target file and want to generate reusable, multi-instance C
entry-point functions that are reentrant, consider:

• Using dynamic memory allocation to initialize model data structures. Select Use dynamic
memory allocation for model initialization.

• Packing values of model root-level Inport blocks into a structure, packing values of root-level
Outport blocks into a second structure, and passing the structures to the execution function as
arguments by reference. Set Pass root-level I/O as to Structure reference.

• Packing values of model root-level Inport blocks and Outport blocks into the real-time model data
structure and passing that structure to the execution function as an argument by reference. Set
Pass root-level I/O as to Part of model data structure.
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Choose an Approach for Configuring Generated C Function Interfaces
To facilitate integration of external and generated code and achieve compliance with code standards
and guidelines, you can use the Code Mappings editor or code mappings API to configure how the
code generator produces function interfaces from a model or subsystem.

Configuration More Information
Default naming rules for categories of functions
(initialize/terminate, execution, and shared
utility) across a model

“Configure Default Code Generation for
Functions” on page 33-20

Name for individual entry-point functions
(override the default naming rule)

“Configure Names for Individual C Entry-Point
Functions” on page 33-117

Step function interface (function name, return
value, and argument C type qualifiers, names,
and order) for the base rate step entry-point
function interactively

“Configure Name and Arguments for Individual
Step Functions” on page 33-118

Function interfaces (function name, return value,
and argument C type qualifiers, names, and
order) for Simulink Function and Function Caller
blocks interactively

“Configure Entry-Point Function Interfaces for
Simulink Function and Function Caller Blocks” on
page 40-2

You can use software-in-the-loop (SIL) testing to verify code generated for customized entry-point
functions. Create a SIL block by using your generated code. Then, integrate the SIL block into a
model to verify that the generated code provides the same result as the original model or nonvirtual
subsystem. For more information, see “Choose a SIL or PIL Approach” on page 80-11.

Configure Default Code Generation Settings for a Function Category
Reduce the effort of preparing a model for C code generation by specifying default configurations for
categories of functions across a model. For example, you can configure function name rules and
placement of function code in memory sections. Applying default configurations can save time and
reduce the risk of introducing errors in code, especially for models that have a large number
functions.

The code generator produces entry-point functions for these categories of model functions:

Function Category Description
Initialize/Terminate Functions that initialize and turn off a system
Execution Functions that initiate execution and resets
Shared utility Shared utility function code

Configure default code mappings for functions by using the Code Mappings editor or code
mappings API function setFunctionDefault. Using these interfaces, you can associate a function
category with a function customization template defined in the model's Embedded Coder Dictionary.

If your application requires that you configure the placement of entry-point functions in memory, for
example, to optimize the generated code for specific hardware, you can apply a default memory
section to a category of functions across a model. In the Code Mappings editor, map a function
category to a function customization template that is defined to use a specific memory section. See .
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If a function customization template does not exist, you can create one by using the Embedded Coder
Dictionary (see “Define Storage Classes, Memory Sections, and Function Templates for Software
Architecture” on page 31-2).

For an example of how to configure default configurations for function categories, see “Configure
Default C Code Generation for Categories of Data Elements and Functions” on page 33-15.

Configure Names for Individual C Entry-Point Functions
For your generated C code to adhere to code standards and guidelines or to more easily integrate
that code with external code, you can configure the name of an individual entry-point function. For
example, you can name the initialize function generated for a model myInitFunc.

If your model meets at least one of these criteria, consider configuring the names of functions
individually:

• Uses multiple functions that have unique naming requirements.
• Uses few functions.
• Has a default configuration for a function category and you need to override the configuration for

a specific function.

Configure function names for individual step functions by using the Code Mappings editor or code
mappings API function setFunction. Using these interfaces, you can associate a function with a
function customization template that is defined in the model's Embedded Coder Dictionary and
specify a function name.

This example shows how to change the name of the initialize function for model
rtwdemo_fcnprotoctrl.

1 Open and save a copy of model rtwdemo_fcnprotoctrl in a writable location.
2 Open the Embedded Coder app.
3 On the C Code tab, select Code Interface > Individual Element Code Mappings.
4 In the Code Mappings editor, Functions tab, change the function name by using one of these

methods:

• In the Function Name column, enter a name for the function.
• In the Function Preview column, click the function prototype hyperlink to open a
configuration dialog box. In the C Initialize Function Name field, enter the function name.
Click Apply to verify the change in the C function prototype field or click OK to exit the
dialog box and view the function name in the Function Preview column of the Code
Mappings editor.

For this example, change the name of the initialize function to fcnprotoctrl_init.
5 Save the model.
6 Generate code.
7 Verify the changes in the generated code. In the Code view, find instances of function name

fcnprotoctrl_init. The function name appears in generated files
rtwdemo_fcnprotoctrl.h and rtwdemo_fcnprotoctrl.c.

• In rtwdemo_fcnprotoctrl.h:
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extern void fcnprotoctrl_init(void);

• In rtwdemo_fcnprotoctrl.c:
void fcnprotoctrl_init(void)
{
  ...
}

Configure Name and Arguments for Individual Step Functions
For your generated C code to adhere to code standards and guidelines or to more easily integrate the
code with external code, you can configure the name and arguments of individual step functions
generated for Simulink periodic functions. You can customize these aspects of a step function:

• Function name
• Argument names
• Order of the arguments
• Return value and argument data qualifiers
• Buffering optimizations for arguments

If your model meets at least one of these criteria, consider configuring the name and arguments of a
step function individually:

• Is a periodic, single-tasking model for which the code generator produces one step function.
• Has a default configuration for Execution function category and you need to override the
configuration for a specific step function.

Configure code mappings for individual step functions by using the Code Mappings editor or code
mappings API function setFunction. Using these interfaces, you can associate a function with a
function customization template that is defined in the model's Embedded Coder Dictionary and
completely customize the step function prototype.

This example shows how to customize the step function name and arguments for a rate-based, single-
tasking model.

Open the Configuration Dialog Box

1. Open and save a copy of model rtwdemo_fcnprotoctrl to a writable location.

2. Open the Embedded Coder app.

3. On the C Code tab, select Code Interface > Individual Element Code Mappings.

4. In the Code Mappings editor, click the Functions tab.

5. For the step function row, in the Function Preview column, click the prototype hyperlink to open
the Configure C Step Function Interface dialog box.
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In the Configure C Step Function Interface dialog box, the C function prototype field displays a
preview of changes that you make to the function prototype.

For models configured to generate multi-instance code, see “Generate Reentrant Code from Top
Models” on page 7-18.

Customize the Function Name

1. In the Configure C Step Function Interface dialog box, set C Step Function Name to
fcnprotoctrl_run. The function preview is updated to reflect the new function name.

2. Click Apply, close the dialog box, and save the model.

3. Generate code and verify the name change.

• Click the Code tab. In the Code view file list, select file rtwdemo_fcnprotoctrl.h. In the
Search field, verify that the list of code elements includes function name fcnprotoctrl_run. To
view the declaration, select the function name.
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The declaration is highlighted in the code:

• Verify the name change in file rtwdemo_fcnprotoctrl.c. To view the source code (definition),
in the Search field, select fcnprotoctrl_run.

For more examples, see “Configure Names for Individual C Entry-Point Functions” on page 33-117.

Customize Function Arguments

Configure Global Data Structures

By default, a top or referenced model uses a void-void step function to pass data. This type of
function enables generated code to communicate with external code by accessing global data stored
as data structures that reside in shared memory.

To configure a model to have a void-void step function, open the Configure C Step Function
Interface dialog box and clear the Configure arguments for Step function prototype check box.
Verify the change in the C function prototype preview.

Configure Arguments

Rate-based model step functions can use arguments to pass data. You can customize these argument
settings:

• Return value
• Type qualifiers
• Names
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• Order

Example

1. Open the Configure C Step Function Interface dialog box. In the Code Mappings editor, click the
Functions tab. Then, click the function preview for the step function.

2. In the Configure C Step Function Interface dialog box, select Configure arguments for Step
function prototype.

3. Click Get default. The dialog box expands to show a field for configuring the function return value
and a table that lists input and output arguments with default settings.
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4. Customize the return value of the step function. Set C return argument to either void or one of
the output arguments. For this example, select void.

5. For each argument, specify a C Type Qualifier.

Type Qualifiers:
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• Value: Value, for example, arg
• Const: Value with the const qualifier, for example, const arg
• Pointer to const: Value with const qualifier and referenced by pointer, for example, const

*arg
• Pointer: Reference by pointer, for example, *arg
• Const pointer to const: Value with const qualifier, reference by pointer, and the pointer

itself, for example, const *const arg

Models that include a referenced model

• For a referenced model, the type qualifier for a root input argument in the step function interface
is set to Auto. The code generator uses the interface specification by generating a type cast that
discards the const qualifier from the source signal.

• For the parent of the reference model, the type qualifier for the source signal is set to a value
other than Auto. To override this behavior, add a const type qualifier to the referenced model.

For this example, make no changes to the C type qualifier.

6. Customize the argument names by editing values in the C Identifier Name column.

For this example, change the names of the arguments by removing the underscores, for example,
change arg_In1 to argIn1.

7. Customize the argument order by dragging table rows to new positions.

For this example, move Out1 to the first position. Move Out 2 to the third position.

8. Validate, apply your changes, close the dialog box, and save the model.

9. Generate code and verify the changes in the Code view.

• Verify your changes in file rtwdemo_fcnprotoctrl.h by checking that the Search field includes
function fcnprotoctrl_run.To view the function declaration, select the function name.

• Verify your changes in file rtwdemo_fcnprotoctrl.c.To view the definition for the function,
select function name fcnprotoctrl_run.

Prototype Different From Preview

In the Configure C Step Function Interface dialog box, the function prototype preview for a
referenced model can show fewer arguments than the function prototype in the generated code.
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For example, consider a model named mdlref_counter with an inport (arg_input), an outport
(arg_output), and a saturation block with limits that have workspace parameter argument names
lower_saturation_limit and upper_saturation_limit. The Configure C Step Function
Interface dialog box shows a function prototype preview as:

mdlref_counter_custom(arg_input, arg_output)

In the generated code, the prototype includes the parameter arguments:

mdlref_counter_custom(real_T arg_input, real_T arg_output, real_T 
  rtp_lower_saturation_limit, real_T rtp_upper_saturation_limit)

Optimize Buffering for Arguments

You can optimize the buffering required for I/O arguments in the step function for a model. If you
adhere to these requirements when configuring an inport and outport pair, the code generator
merges the corresponding arguments and reuses the associated buffer.

• The Inport and Outport blocks must have the same properties, including data type, dimension, and
sample rate.

• The sample rate of the Inport and Outport blocks must be the same as the base rate of the model.
• A conditionally executed subsystem cannot drive the Outport block.
• A single, nonvirtual block output must drive the Outport block. For example, a Mux block, which

merges multiple buffers, cannot drive the Outport block.
• In the Configure C Step Function Interface dialog box, you must configure the Inport and Outport

with the same C type qualifier and identifier name.

This example shows how to merge arguments for ports In3 and Out2 for example model
rtwdemo_fcnprotoctrl.

1. Open the Configure C Step Function Interface dialog box for the model rtwdemo_fcnprotoctrl.

2. Open the display for the arguments by selecting Configure arguments for Step function
prototype.

3. For ports In3 and Out2, set C Type Qualifier to Pointer and C Identifier Name to sharedArg.

4. Verify that the preview shows the merged argument for argIn3 and argOut2.
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5. Validate, apply your changes, close the dialog box, and save the model.

6. Generate and view the code. In the Code view, search for the fcnprotoctrl_run function and
check the function interface. For this example, the shared argument appears in read code for the
Inport block and write code for the Outport block.
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Configure Code Generation Settings for C Entry-Point Functions
Programmatically
To automate configuration of model functions for C code generation, use the programming interface
for code mappings. For example, when creating custom block libraries or part of an application test
environment, use the programming interface to automate function configuration.

33 Configuring Data and Functions in the Generated Code

33-126



Typical uses of these functions include:

• Create a function interface.
• Modify an existing function interface.
• Create a function interface, starting with default configuration information from a model.
• Reset the model function interface to the default ERT function configuration.

For an example of how to configure code generation settings for C entry-point functions
programmatically, see “Configure Default Data and Function Code Generation Programmatically” on
page 33-24. That example shows how to configure default settings for function categories and
individual functions.

How to Interface with Generated Entry-Point Functions
1 After generating code for a model, use the Code view to review the generated entry-point

functions and, if applicable, variables representing external input and output ports.
2 Add #include statements to your external code that include the generated header files that

declare the model entry-point functions.
3 Add an #include statement that includes the generated file rtwtypes.h. This file provides type

definitions, #define statements, and enumerations.
4 Initialize target-specific data structures and hardware, such as ADCs or DACs.
5 If applicable, initialize data for each instance of a reusable model.
6 If applicable, write input data to generated variables that represent model Inport blocks.
7 Call the generated entry-point functions or set up use of the rt_OneStep function.
8 If applicable, read data from generated variables that represent model Outport blocks.

For more information, see “Deploy Generated Standalone Executable Programs To Target Hardware”
on page 66-2.

C Function Interface Customization Limitations
These limitations apply to customizations for generated C function interfaces:

• You must select the model configuration parameter Single output/update function.
• Multirate models are supported, but you must configure the models for single tasking.
• You must configure root-level inports and outports to use the Default storage class.
• If you choose to customize a function interface, you must provide your own custom main program.

You cannot configure the function interface with the static rt_main.c that MathWorks provides.
Specifying a function interface configuration other than the default creates a mismatch between
the generated code and the default static rt_main.c.

• The code generator removes the data structure for the root inports of the model unless a
subsystem implemented by a nonreusable function uses the value of one or more of the inports.

• The code generator removes the data structure for the root outports of the model except when you
enable MAT-file logging or if the sample time of one or more of the outports is not the fundamental
base rate (including a constant rate).

• If you copy a subsystem block to create a block in a new model or the same model, the function
interface information from the original subsystem block is not copied to the new subsystem block.
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• If you have Stateflow, for a Stateflow chart that uses a model root inport value or that calls a
subsystem that uses a model root inport value, do one of the following to generate code:

• Clear the Execute (enter) Chart At Initialization check box in the Stateflow chart.
• Make the Stateflow function a nonreusable function.
• Insert a Simulink Signal Conversion block immediately after the root inport. In the Signal

Conversion block parameters dialog box, select Exclude this block from 'Block reduction'
optimization.

• If a model root inport value connects to a Simscape conversion block, insert a Simulink Signal
Conversion block between the root inport and the Simscape conversion block. In the Signal
Conversion block parameters dialog box, select Exclude this block from 'Block reduction'
optimization.

• When building a referenced model that is configured with a function interface, do not use virtual
buses as inputs or outputs to the referenced model. Use nonvirtual buses instead.

• If the C function interface is not the default, the value is ignored for the model configuration
parameter Pass fixed-size scalar root inputs by value for code generation. For more
information, see “Pass fixed-size scalar root inputs by value for code generation”.

See Also
Function Caller | Simulink Function

More About
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
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Configure Multi-Instance Code Generation
By default, for top models, the code generator produces code that is not reentrant. Entry-point
functions have a void-void interface. Code communicates with other code by sharing access to
global data structures that reside in shared memory.

For applications that can benefit from code reuse and require that each use or instance of the code
maintains its own unique data, configure a model such that the code generator produces reentrant,
multi-instantiable code. Multiple programs can use reentrant code simultaneously. When you
configure a model for reentrancy, the execution (step) entry-point function uses root-level input and
output arguments instead of global data structures.

Configure a Top Model for Multi-Instance Code Generation
Set model configuration parameter Code interface packaging to Reusable function.

Apply additional diagnostic and code generation control by setting these model configuration
parameters:

• To select the severity level for diagnostic messages that the code generator displays when a model
does not meet requirements for multi-instance code, set parameter Multi-instance code error
diagnostic to None, Warning, or Error.

• To control how the generated code passes root-level model input and output to the reusable
execution (step) function (requires Embedded Coder), set parameter Pass root-level I/O as to
Individual arguments, Structure reference, or Part of model data structure.

• To include a function in the generated file model.c that uses malloc to dynamically allocate
memory for model data structures (requires Embedded Coder), set parameter Use dynamic
memory allocation for model initialization to On.

For more information, see “Generate Reentrant Code from Top Models” on page 7-18.

Configure a Referenced Model for Multi-Instance Code Generation
Set model configuration parameter Total number of instances allowed per top model to
Multiple. With this parameter setting, a model can be referenced more than once in a model
hierarchy, if it contains not constructs that preclude multiple references. An error occurs if the model
cannot be referenced multiple times, even if only one reference exists.

For more information, see “Generate Reentrant Code from Simulink Function Blocks” on page 7-23.
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Configure Data Interfaces

Configure Default Code Generation for Data
1 Click the Code Mappings - C tab.
2 In the Code Mappings editor, update the model to include the latest model data by clicking the

update model data button.
3 Click the Data Defaults tab.
4 In the Data Defaults table, select a row for a model data element category.
5 In the Storage Class column, select a storage class. If your model is linked to a Simulink data

dictionary that includes a shared coder dictionary for which defaults are set up, you can select
Dictionary Default. For help on choosing a storage class, see “Choose Storage Class for
Controlling Data Representation in Generated Code” on page 34-74. For information on using
dictionary defaults, see “Configure Model Elements for Code Generation with Definitions Stored
in Shared Data Dictionary” on page 33-22. If you need to define a new storage class, see “Define
Storage Classes, Memory Sections, and Function Templates for Software Architecture” on page
31-2.

6 In the Property Inspector, add values for unspecified properties. For example, if you select
storage class ImportFromFile, specify a value for the property HeaderFile.

7 Save the model.

Override Default Data Interface for Individual Data Elements
1 Click the Model Data Editor tab.
2 Update the model to include the latest model data by clicking the update model data button.
3 In the Model Data Editor, with the view set to Code, click the tab for the type of data element

that you want to configure.
4 In the filter text box, enter a string that will help you find the row for that data element.
5 In the Storage Class column, select a storage class. For example, you might want to change the

storage class setting for Model Workspace parameters to Model default.
6 In the table or Property Inspector, set values for available properties.
7 Save the model.
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Configure Entry-Point Function Interfaces

Define Function Customization Templates
Unless someone has defined function customization templates for a model, the Code Mappings editor
presents Default as the only template option. To define a template, use the Embedded Coder
Dictionary.

1 Open the Embedded Coder Dictionary. In the C Code tab, select Settings > Embedded Coder
Dictionary.

2 In the Embedded Coder Dictionary, click the Function Customization Templates tab.
3 Click Add.
4 In the new row of the table, name the template.
5 As required by your function interface:

• In the Function Name column, specify a default naming rule for entry-point functions.
• In the Memory Section column, specify the name of an available memory section.

The preview shows the results of your changes and additions.
6 Close the dictionary.

Configure Default Code Generation for Entry-Point Functions
1 Define a function customization template in the Embedded Coder Dictionary.
2 In the Code Mappings editor, click the Function Defaults tab.
3 In the Function Defaults table, select a row for a model function category.
4 In the Function Customization Template column, select a customization template. If your

model is linked to a Simulink data dictionary that includes a shared coder dictionary for which
defaults are set up, you can select Dictionary Default. For information on using dictionary
defaults, see “Configure Model Elements for Code Generation with Definitions Stored in Shared
Data Dictionary” on page 33-22. If you need to define a new customization template, for more
information, see “Define Storage Classes, Memory Sections, and Function Templates for
Software Architecture” on page 31-2.

5 Save the model.

Override Default Code Generation for Entry-Point Functions
1 In the Code Mappings editor, click the Functions tab.
2 In the Source column, select an entry-point function for which you want to override the default

interface configuration.
3 As required by your function interface:

• Select a function customization template.
• Specify a unique function name.

4 If your entry-point function is an execution function, you can customize the interface arguments.
By default, the code generator produces a void-void interface (without arguments) and
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assumes variables are global. To configure the interface to pass arguments, in the Function
Preview column, click the prototype hyperlink to open a configuration dialog box.

5 In the function interface configuration dialog box, select Configure arguments for Step
function prototype.

6 Click Get Default. A table shows a list of current argument settings.
7 In the table, you can change C type qualifiers, identifier names, and argument order as required

by the function interface. Change the order of the arguments by dragging them to locations in
the list. As you make changes, use the prototype preview near the top of the dialog box to verify
the results.

8 Validate your changes and save the model.
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Configure Internal Data

Configure Default Representation of Internal Data
1 In the Code Mapping Editor, click the Data Defaults tab.
2 Select the row representing the category of internal data that you want to configure.
3 In the Storage Class column, select a storage class. If your model is linked to a Simulink data

dictionary that includes a shared coder dictionary for which defaults are set up, you can select
Dictionary Default. For help on choosing a storage class, see “Choose Storage Class for
Controlling Data Representation in Generated Code” on page 34-74. For information on using
dictionary defaults, see “Configure Model Elements for Code Generation with Definitions Stored
in Shared Data Dictionary” on page 33-22. If you need to define a new storage class, see “Define
Storage Classes, Memory Sections, and Function Templates for Software Architecture” on page
31-2.

4 In the Property Inspector, add values for unspecified properties. For example, if you select
storage class Const, specify values for properties HeaderFile and DefinitionFile.

5 Save the model.

Override Default Representation for Individual Internal Data Elements
1 Click the Model Data Editor tab.
2 In the Model Data Editor, with the view set to Code, click the tab for the type of data element

that you want to configure.
3 Update the model to include the latest model data by clicking the update model data button.
4 In the filter text box, enter a string that will help you find the row for the data element.
5 In the Storage Class column, select a storage class. For example, you might want to change the

storage class setting for Model Workspace parameters to Model default.
6 In the table or Property Inspector, set values for available properties.
7 Save the model.
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Configure Subsystem Function Packaging and Interface
1 In the Simulink Editor, select the subsystem that you want to configure.
2 In the Property Inspector, expand Code Generation.
3 Set Function packaging to Nonresuable function or Reusable function.
4 Configure the function name. Set Function name options to Use subsystem name or User

specified. If you select User specified, specify a value for the Function name property.
5 Configure the file name for the function code. Set File name options to Use subsystem name,

Use function name, or User specified. If you select User specified, specify a value for
the File name (no extension) property.

6 If you set Function packaging to Nonresuable function, configure the function interface.
Set Function interface to void-void, Allow arguments (Optimized), or Allow
arguments (Match graphical interface).

7 If you want the code generator to declare subsystem data independently from parent model data,
select property Function with separate data.

8 Save the model.

For more information, see “Control Generation of Functions for Subsystems” on page 3-2.
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Data Representation in Simulink Coder

• “Preserve Variables in Generated Code” on page 34-2
• “Access Signal, State, and Parameter Data During Execution” on page 34-17
• “Data Structures in the Generated Code” on page 34-31
• “How Generated Code Exchanges Data with an Environment” on page 34-35
• “Control Data and Function Interface in Generated Code” on page 34-44
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Choose Data Configuration Approach” on page 34-69
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• “Air-Fuel Ratio Control System with Fixed-Point Data” on page 34-201
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Preserve Variables in Generated Code
As you iteratively develop a model, you capture the values of signals and states that model execution
generates. You also tune parameter values during execution to observe results on the signals and
states. You can then base your design decisions upon analysis of these outputs. To access signal,
state, and parameter data in a rapid prototyping environment, you can configure the generated code
to store the data in addressable memory.

Depending on the system target file that you use (such as grt.tlc), by default, optimization settings
can make the generated code more efficient by:

• Eliminating unnecessary global and local storage for signals and some states.

However, the optimizations do not eliminate storage for root-level Inport and Outport blocks,
which represent the primary inputs and outputs of a system. To access this data, you do not need
to take optimizations into consideration.

• Inlining the numeric values of block parameters. The code does not store the parameters in
memory, so you cannot interact with the parameters during code execution.

To generate code that instead allocates addressable memory for this data, you can disable the
optimizations, or override the optimizations by specifying code generation settings for individual data
items.

Access Signal, State, and Parameter Data During Execution
As you iteratively develop a model, you capture output signal and state data that model execution
generates. You also tune parameter values during execution to observe results on the outputs. You
can then base your design decisions upon analysis of these outputs. To access this signal, state, and
parameter data in a rapid prototyping environment, you can configure the generated code to store
the data in addressable memory.

By default, optimization settings make the generated code more efficient by eliminating unnecessary
signal storage and inlining the numeric values of block parameters. To generate code that instead
allocates addressable memory for this data, you can disable the optimizations or specify code
generation settings for individual data items.

Explore Example Model

Run a script that prepares the model rtwdemo_configrpinterface for this example.

prepare_rtwdemo_configrpinterface

This data is configured for code generation:

• Parameters UPPER, LOWER, K1, Table1, and Table2
• Signals In1, In2, In3, In4, and Out1
• States X (delay) and mode (data store memory write)

Open the example model, rtwdemo_configrpinterface.

rtwdemo_configrpinterface
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The model loads numeric MATLAB variables into the model workspace. The workspace variables set
some block parameters in the model. However, the Gain block in the model uses the literal value 2.

Disable Optimizations

1. In the model, clear the model configuration parameter Signal storage reuse. When you clear this
optimization and other optimizations such as Eliminate superfluous local variables (expression
folding), the generated code allocates memory for signal lines. Clearing Signal storage reuse
disables most of the other optimizations.

set_param('rtwdemo_configrpinterface','OptimizeBlockIOStorage','off')

2. Set the model configuration parameter Default parameter behavior to Tunable. When set to
Tunable, this configuration parameter causes the generated code to allocate memory for block
parameters and workspace variables.

set_param('rtwdemo_configrpinterface','DefaultParameterBehavior','Tunable')

3. Generate code.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of build procedure for: rtwdemo_configrpinterface

Build Summary
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Top model targets built:

Model                      Action                       Rebuild Reason                                    
==========================================================================================================
rtwdemo_configrpinterface  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 36.843s

4. In the code generation report, view the file rtwdemo_configrpinterface.h. This header file
defines a structure type that contains signal data. The structure contains fields that each represent a
signal line in the model. For example, the output signal of the Gain block, whose name is Gain,
appears as the field Gain.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.h');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    'B_rtwdemo_configrpinterface_T;',1,1)

/* Block signals (default storage) */
typedef struct {
  real_T Delay;                        /* '<Root>/Delay' */
  real_T Table2;                       /* '<Root>/Table2' */
  real_T Table1;                       /* '<Root>/Table1' */
  real_T Gain;                         /* '<Root>/Gain' */
  boolean_T RelOp1;                    /* '<Root>/RelOp1' */
  boolean_T RelOp2;                    /* '<Root>/RelOp2' */
  boolean_T LogOp;                     /* '<Root>/LogOp' */
  boolean_T DataStoreRead;             /* '<Root>/Data Store Read' */
} B_rtwdemo_configrpinterface_T;

The file defines a structure type that contains block parameter data. For example, the Gain
parameter of the Gain block appears as the field Gain_Gain. The other fields of the structure
represent other block parameters and workspace variables from the model, including initial
conditions for signals and states.

rtwdemodbtype(file,'/* Parameters (default storage) */',...
    '/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */
struct P_rtwdemo_configrpinterface_T_ {
  Table1_Type Table1;                  /* Variable: Table1
                                        * Referenced by: '<Root>/Table1'
                                        */
  Table2_Type Table2;                  /* Variable: Table2
                                        * Referenced by: '<Root>/Table2'
                                        */
  real_T LOWER;                        /* Variable: LOWER
                                        * Referenced by: '<Root>/Constant2'
                                        */
  real_T UPPER;                        /* Variable: UPPER
                                        * Referenced by: '<Root>/Constant1'
                                        */
  real_T Gain_Gain;                    /* Expression: 2
                                        * Referenced by: '<Root>/Gain'
                                        */
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  real_T Delay_InitialCondition;       /* Expression: 0
                                        * Referenced by: '<Root>/Delay'
                                        */
  uint32_T Table2_maxIndex[2];         /* Computed Parameter: Table2_maxIndex
                                        * Referenced by: '<Root>/Table2'
                                        */
  boolean_T DataStoreMemory_InitialValue;
                             /* Computed Parameter: DataStoreMemory_InitialValue
                              * Referenced by: '<Root>/Data Store Memory'
                              */
};

5. View the file rtwdemo_configrpinterface_data.c. This source file allocates global memory
for a parameter structure and initializes the field values based on the parameter values in the model.

6. View the source file rtwdemo_configrpinterface.c. The code allocates global memory for a
structure variable that contains signal data.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    'B_rtwdemo_configrpinterface_T rtwdemo_configrpinterface_B;',1,1)

/* Block signals (default storage) */
B_rtwdemo_configrpinterface_T rtwdemo_configrpinterface_B;

The code algorithm in the model step function calculates the signal values. It then assigns these
values to the fields of the signal structure. To perform the calculations, the algorithm uses the
parameter values from the fields of the parameter structure.

Exclude Data Items from Optimizations

When you want to select code generation optimizations such as Signal storage reuse, you can
preserve individual data items from the optimizations. The generated code then allocates addressable
memory for the items.

Select the optimizations that you previously cleared.

set_param('rtwdemo_configrpinterface','OptimizeBlockIOStorage','on')
set_param('rtwdemo_configrpinterface','LocalBlockOutputs','on')
set_param('rtwdemo_configrpinterface','DefaultParameterBehavior','Inlined')

1. In the C Code tab, select Code Interface > Individual Element Code Mappings.

2. In the Code Mappings editor, inspect the Signals/States tab.

3. In the model, select the output signal of the Gain block.

4. Pause on the ellipsis that appears above or below the signal line to open the action bar. Click the
Add Signal button. In the Code Mappings editor, the Signals node expands and lists the signal that
you added.

cm = coder.mapping.api.get('rtwdemo_configrpinterface');
gain_ports = get_param('rtwdemo_configrpinterface/Gain','PortHandles');
gain_outPort = gain_ports.Outport;
addSignal(cm,gain_outPort);
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5. Apply the default storage class for Outports to the signal by setting Storage Class to Model
default.

setSignal(cm,gain_outPort,'StorageClass','Model default','Identifier','Gain');

6. In the model, select the Gain block.

7. In the Property Inspector, set the gain value to the model workspace parameter object K1.

8. In the Code Mappings editor, on the Parameters tab, expand Model Parameters.

9. Select parameter K1. Apply a storage class other than Auto by setting Storage class. For
example, use the storage class Model default. By using Model default, K1 acquires the default
storage class specified for model parameters, Default, and appears as a field of the global
parameters structure.

set_param('rtwdemo_configrpinterface/Gain','Gain','K1');
setModelParameter(cm,'K1','StorageClass','Model default');

10. Generate code.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of build procedure for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action                       Rebuild Reason                   
=========================================================================================
rtwdemo_configrpinterface  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.669s

11. In the code generation report, view the file rtwdemo_configrpinterface.h. The structure
that contains signal data now defines only one field, Gain, which represents the test-pointed output
of the Gain block.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.h');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    'B_rtwdemo_configrpinterface_T;',1,1)

/* Block signals (default storage) */
typedef struct {
  real_T Gain;                         /* '<Root>/Gain' */
} B_rtwdemo_configrpinterface_T;

The structure that contains block parameter data defines one field, K1, which represents the
parameter object K1.

rtwdemodbtype(file,'/* Parameters (default storage) */',...
    '/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */
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struct P_rtwdemo_configrpinterface_T_ {
  int8_T K1;                           /* Variable: K1
                                        * Referenced by: '<Root>/Gain'
                                        */
};

Access Data Through Generated Interfaces

You can configure the generated code to contain extra code and files so that you can access model
data through standardized interfaces. For example, use the C API to log signal data and tune
parameters during execution.

Copy this custom source code into a file named ex_myHandCode.c in your current folder.

#include "ex_myHandHdr.h"
 
#define paramIdx 0 /* Index of the target parameter, 
determined by inspecting the array of structures generated by the C API. */
#define sigIdx 0 /* Index of the target signal, 
determined by inspecting the array of structures generated by the C API. */
 
void tuneFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr)
{
    /* Take action with the parameter value only at 
       the beginning of simulation and at the 5-second mark. */
    if (*tPtr == 0 || *tPtr == 5) {
        
        /* Local variables to store information extracted from 
           the model mapping information (mmi). */
        void** dataAddrMap;
        const rtwCAPI_DataTypeMap *dataTypeMap;
        const rtwCAPI_ModelParameters *params;
        int_T addrIdx;
        uint16_T dTypeIdx;
        uint8_T slDataType;
        
        /* Use built-in C API macros to extract information. */
        dataAddrMap = rtwCAPI_GetDataAddressMap(mmi);
        dataTypeMap = rtwCAPI_GetDataTypeMap(mmi);
        params = rtwCAPI_GetModelParameters(mmi);
        addrIdx = rtwCAPI_GetModelParameterAddrIdx(params,paramIdx);
        dTypeIdx =  rtwCAPI_GetModelParameterDataTypeIdx(params,paramIdx);
        slDataType = rtwCAPI_GetDataTypeSLId(dataTypeMap, dTypeIdx);
        
        /* Handle data types 'double' and 'int8'. */
        switch (slDataType) {
            
            case SS_DOUBLE: {
                real_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                /* At the 5-second mark, increment the parameter value by 1. */
                if (*tPtr == 5) {
                    (*dataAddress)++;
                }
                printf("Parameter value is %f\n", *dataAddress);
                break;
            }
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            case SS_INT8: {
                int8_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                if (*tPtr == 5) {
                    (*dataAddress)++;
                }
                printf("Parameter value is %i\n", *dataAddress);
                break;
            }
        }
    }
}
 
void logFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr)
{
    /* Take action with the signal value only when 
       the simulation time is an integer value. */
    if (*tPtr-(int_T)*tPtr == 0) {
        
        /* Local variables to store information extracted from 
           the model mapping information (mmi). */
        void** dataAddrMap;
        const rtwCAPI_DataTypeMap *dataTypeMap;
        const rtwCAPI_Signals *sigs;
        int_T addrIdx;
        uint16_T dTypeIdx;
        uint8_T slDataType;
        
        /* Use built-in C API macros to extract information. */
        dataAddrMap = rtwCAPI_GetDataAddressMap(mmi);
        dataTypeMap = rtwCAPI_GetDataTypeMap(mmi);
        sigs = rtwCAPI_GetSignals(mmi);
        addrIdx = rtwCAPI_GetSignalAddrIdx(sigs,sigIdx);
        dTypeIdx =  rtwCAPI_GetSignalDataTypeIdx(sigs,sigIdx);
        slDataType = rtwCAPI_GetDataTypeSLId(dataTypeMap, dTypeIdx);
        
        /* Handle data types 'double' and 'single'. */
        switch (slDataType) {
            
            case SS_DOUBLE: {
                real_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                printf("Signal value is %f\n", *dataAddress);
                break;
            }
            
            case SS_SINGLE: {
                real32_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                printf("Signal value is %f\n", *dataAddress);
                break;
            }
        }
    }
}

2. Copy this custom header code into a file named ex_myHandHdr.h in your current folder.
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#include <stdio.h>
#include <string.h>
#include <math.h>
/* Include rtw_modelmap.h for definitions of C API macros. */
#include "rtw_modelmap.h"
#include "builtin_typeid_types.h"
#include "rtwtypes.h"
void tuneFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr);
void logFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr);

These files use the C API to access signal and parameter data in the code that you generate from the
example model.

3. Set model configuration parameters Header file and Source files to #include
"ex_myHandHdr.h" and ex_myHandCode.c, respectively.

set_param('rtwdemo_configrpinterface','CustomHeaderCode','#include "ex_myHandHdr.h"')
set_param('rtwdemo_configrpinterface','CustomSource','ex_myHandCode.c')

4. Select model configuration parameter MAT-file Logging. The generated executable runs only until
the simulation stop time (which you set in the model configuration parameters).

set_param('rtwdemo_configrpinterface','MatFileLogging','on')

5. Select C API model configuration parameters parameters, signals, states, and root-level I/O.

set_param('rtwdemo_configrpinterface','RTWCAPIParams','on')
set_param('rtwdemo_configrpinterface','RTWCAPISignals','on')
set_param('rtwdemo_configrpinterface','RTWCAPIStates','on')
set_param('rtwdemo_configrpinterface','RTWCAPIRootIO','on')

6. Load the Custom Code block library.

custcode

7. Add a System Outputs block to the model.
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add_block('custcode/System Outputs','rtwdemo_configrpinterface/System Outputs')

8. In the System Outputs block dialog box, set System Outputs Function Execution Code to this
code:

{
rtwdemo_configrpinterface_U.input2++;
rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);
tuneFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
}

9. In the block dialog box, set System Outputs Function Exit Code to this code:

{
rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);
logFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
}

Alternatively, to configure the System Outputs block, at the command prompt, use these commands:

temp.TLCFile = 'custcode';
temp.Location = 'System Outputs Function';
temp.Middle = sprintf(['{\nrtwdemo_configrpinterface_U.input2++;'...
    '\nrtwCAPI_ModelMappingInfo *MMI = '...
    '&(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);'...
    '\ntuneFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));\n}']);
temp.Bottom = sprintf(['{\nrtwCAPI_ModelMappingInfo *MMI = '...
    '&(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);'...
    '\nlogFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));\n}']);
set_param('rtwdemo_configrpinterface/System Outputs','RTWdata',temp)

10. Generate code.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of build procedure for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action                       Rebuild Reason                   
=========================================================================================
rtwdemo_configrpinterface  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 17.796s

11. In the code generation report, view the interface file rtwdemo_configrpinterface_capi.c.
This file initializes the arrays of structures that you can use to interact with data items through the C
API. For example, in the array of structures rtBlockSignals, the first structure (index 0) describes
the test-pointed output signal of the Gain block in the model.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface_capi.c');
rtwdemodbtype(file,'/* Block output signal information */',...
    '/* Individual block tuning',1,0)

/* Block output signal information */
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static const rtwCAPI_Signals rtBlockSignals[] = {
  /* addrMapIndex, sysNum, blockPath,
   * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex
   */
  { 0, 0, TARGET_STRING("rtwdemo_configrpinterface/Gain"),
    TARGET_STRING(""), 0, 0, 0, 0, 0 },

  {
    0, 0, (NULL), (NULL), 0, 0, 0, 0, 0
  }
};

The fields of the structure, such as addrMapIndex, indicate indices into other arrays of structures,
such as rtDataAddrMap, that describe the characteristics of the signal. These characteristics
include the address of the signal data (a pointer to the data), the numeric data type, and the
dimensions of the signal.

12. In the file rtwdemo_configrpinterface.c, view the code algorithm in the model step
function. The algorithm first executes the code that you specified in the System Outputs block.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* user code (Output function Body) */',...
    '/* Logic: ''<Root>/LogOp'' incorporates:',1,0)

  /* user code (Output function Body) */

  /* System '<Root>' */
  {
    rtwdemo_configrpinterface_U.input2++;
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo
      (rtwdemo_configrpinterface_M).mmi);
    tuneFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
  }

  /* DataStoreWrite: '<Root>/Data Store Write' incorporates:
   *  Constant: '<Root>/Constant1'
   *  Constant: '<Root>/Constant2'
   *  Inport: '<Root>/In1'
   *  Logic: '<Root>/LogOp'
   *  RelationalOperator: '<Root>/RelOp1'
   *  RelationalOperator: '<Root>/RelOp2'
   */
  mode = ((rtwdemo_configrpinterface_U.In1 > 10.0) ||
          (rtwdemo_configrpinterface_U.In1 < -10.0));

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In2'
   *  Lookup_n-D: '<Root>/Table1'
   */
  rtwdemo_configrpinterface_B.Gain = (real_T)rtwdemo_configrpinterface_P.K1 *
    look1_binlc(rtwdemo_configrpinterface_U.input2, rtCP_Table1_bp01Data,
                rtCP_Table1_tableData, 10U);

  /* Switch: '<Root>/Switch' incorporates:
   *  DataStoreRead: '<Root>/Data Store Read'
   */
  if (mode) {
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    /* Outport: '<Root>/Out1' */
    output = rtwdemo_configrpinterface_B.Gain;
  } else {
    /* Outport: '<Root>/Out1' incorporates:
     *  UnitDelay: '<Root>/Delay'
     */
    output = rtwdemo_configrpinterface_DW.X;
  }

  /* End of Switch: '<Root>/Switch' */

  /* Lookup_n-D: '<Root>/Table2' incorporates:
   *  Inport: '<Root>/In3'
   *  Inport: '<Root>/In4'
   */
  rtwdemo_configrpinterface_DW.X = look2_binlc(rtwdemo_configrpinterface_U.In3,
    rtwdemo_configrpinterface_U.In4, rtCP_Table2_bp01Data, rtCP_Table2_bp02Data,
    rtCP_Table2_tableData, rtCP_Table2_maxIndex, 3U);

  /* user code (Output function Trailer) */

  /* System '<Root>' */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo
      (rtwdemo_configrpinterface_M).mmi);
    logFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
  }

  /* Matfile logging */
  rt_UpdateTXYLogVars(rtwdemo_configrpinterface_M->rtwLogInfo,
                      (&rtwdemo_configrpinterface_M->Timing.taskTime0));

  /* signal main to stop simulation */
  {                                    /* Sample time: [1.0s, 0.0s] */
    if ((rtmGetTFinal(rtwdemo_configrpinterface_M)!=-1) &&
        !((rtmGetTFinal(rtwdemo_configrpinterface_M)-
           rtwdemo_configrpinterface_M->Timing.taskTime0) >
          rtwdemo_configrpinterface_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(rtwdemo_configrpinterface_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
  if (!(++rtwdemo_configrpinterface_M->Timing.clockTick0)) {
    ++rtwdemo_configrpinterface_M->Timing.clockTickH0;
  }

  rtwdemo_configrpinterface_M->Timing.taskTime0 =
    rtwdemo_configrpinterface_M->Timing.clockTick0 *
    rtwdemo_configrpinterface_M->Timing.stepSize0 +
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    rtwdemo_configrpinterface_M->Timing.clockTickH0 *
    rtwdemo_configrpinterface_M->Timing.stepSize0 * 4294967296.0;
}

/* Model initialize function */
void rtwdemo_configrpinterface_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)rtwdemo_configrpinterface_M, 0,
                sizeof(RT_MODEL_rtwdemo_configrpinte_T));
  rtmSetTFinal(rtwdemo_configrpinterface_M, 10.0);
  rtwdemo_configrpinterface_M->Timing.stepSize0 = 1.0;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    rtwdemo_configrpinterface_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
    rtliSetLogT(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogX(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogXFinal(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(rtwdemo_configrpinterface_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(rtwdemo_configrpinterface_M->rtwLogInfo, 0);
    rtliSetLogMaxRows(rtwdemo_configrpinterface_M->rtwLogInfo, 1000);
    rtliSetLogDecimation(rtwdemo_configrpinterface_M->rtwLogInfo, 1);
    rtliSetLogY(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogYSignalInfo(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
    rtliSetLogYSignalPtrs(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
  }

  /* block I/O */
  (void) memset(((void *) &rtwdemo_configrpinterface_B), 0,
                sizeof(B_rtwdemo_configrpinterface_T));

  /* Storage classes */
  output = 0.0;

  /* states (dwork) */
  (void) memset((void *)&rtwdemo_configrpinterface_DW, 0,
                sizeof(DW_rtwdemo_configrpinterface_T));

  /* exported global states */
  mode = false;

  /* external inputs */
  (void)memset(&rtwdemo_configrpinterface_U, 0, sizeof
               (ExtU_rtwdemo_configrpinterfac_T));
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  /* Initialize DataMapInfo substructure containing ModelMap for C API */
  rtwdemo_configrpinterface_InitializeDataMapInfo();

  /* Matfile logging */
  rt_StartDataLoggingWithStartTime(rtwdemo_configrpinterface_M->rtwLogInfo, 0.0,
    rtmGetTFinal(rtwdemo_configrpinterface_M),
    rtwdemo_configrpinterface_M->Timing.stepSize0, (&rtmGetErrorStatus
    (rtwdemo_configrpinterface_M)));

  /* Start for DataStoreMemory: '<Root>/Data Store Memory' */
  mode = false;

  /* InitializeConditions for Lookup_n-D: '<Root>/Table2' incorporates:
   *  UnitDelay: '<Root>/Delay'
   */
  rtwdemo_configrpinterface_DW.X = 0.0;
}

/* Model terminate function */
void rtwdemo_configrpinterface_terminate(void)
{
  /* (no terminate code required) */
}

This code first perturbs the input signal input2 by incrementing the value of the signal each time the
step function executes. The code then uses the built-in macro rtmGetDataMapInfo to extract
model mapping information from the model data structure rtwdemo_configrpinterface_M. The
pointer MMI points to the extracted mapping information, which allows the functions tuneFcn and
logFcn to access the information contained in the arrays of structures that the C API file
rtwdemo_configrpinterface_capi.c defines.

13. View the function tuneFcn in the file ex_myHandCode.c. This function uses the C API (through
the model mapping information mmi) and a pointer to the simulation time to print the value of the
parameter K1 at specific times during code execution. When the simulation time reaches 5 seconds,
the function changes the parameter value in memory. By using a switch case block, the function
can access the parameter data whether the data type is int8 or double.

14. View the code algorithm in the model step function again. Near the end of the function, the
algorithm executes the code that you specified in the System Outputs block. This code calls the
function logFcn.

rtwdemodbtype(file,'/* user code (Output function Trailer) */',...
    '/* Matfile logging */',1,0)

  /* user code (Output function Trailer) */

  /* System '<Root>' */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo
      (rtwdemo_configrpinterface_M).mmi);
    logFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
  }
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15. View the function logFcn in the file ex_myHandCode.c. The function uses the C API to print the
value of the test-pointed signal. The function can access the signal data whether the data type is
single or double.

16. At the command prompt, run the generated executable rtwdemo_configrpinterface.exe.

system('rtwdemo_configrpinterface')

The parameter and signal values appear in the Command Window output.

For more information about data interfaces, including the C API, see “Calibration and Measurement”.

Configure Data Accessibility
Goal Considerations and More Information
Configure signals as
accessible and parameters as
tunable by default

Clear the model configuration parameter Signal storage reuse and set the
configuration parameter Default parameter behavior to Tunable. These
settings prevent the elimination of storage for signals and prevent parameter
inlining. Each block parameter and signal line appears in the generated code as
a field of a structure. For more information about these data structures, see
“How Generated Code Exchanges Data with an Environment” on page 34-35
and “How Generated Code Stores Internal Signal, State, and Parameter Data”
on page 34-49.

For more information about Default parameter behavior, see “Default
parameter behavior”. For more information about optimizations that eliminate
storage for signals, see “How Generated Code Stores Internal Signal, State,
and Parameter Data” on page 34-49 and “Minimize Computations and Storage
for Intermediate Results at Block Outputs”.

Preserve accessibility and
tunability of a data item after
you select optimizations

You can generate more efficient code by selecting optimizations such as Signal
storage reuse, but the code generator eliminates storage for as many data
items as possible. To exclude individual data items from the optimizations:

• Configure signals in the Code Mappings editor. In the editor you can set the
default configuration for signals, add signals of interest to the code
mappings, and then set the storage class for individual signals to the default
storage class or another storage class. Signals can be named by setting the
Identifier storage class property.

• Apply a storage class, such as ExportedGlobal, to states and parameters.
See “C Code Generation Configuration for Model Interface Elements” on
page 33-2.

Represent a data item as a
separate global variable in the
generated code

When you disable optimizations, signal lines, block states, and parameters
appear in the generated code as fields of structures. You cannot control the
names of the structures without Embedded Coder. To instead store a data item
in a separate global variable whose name, file placement, and other
characteristics you can control, apply a storage class to a signal, state, or
Simulink.Parameter object. See “C Code Generation Configuration for
Model Interface Elements” on page 33-2.
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Goal Considerations and More Information
Generate a standardized C-
code interface for accessing
data

You can configure the generated code to contain extra code and files so that
you can access model data through standardized interfaces. For more
information, see “Exchange Data Between Generated and External Code Using
C API” on page 60-2.

Tune parameters and monitor
signals during external mode
simulation

When you generate code and an external executable from a model, you can
simulate the model in external mode to communicate with the running
executable. You can tune parameters and monitor signals during the simulation.
However, in this simulation mode, parameter tunability limitations that apply to
code generation also apply to the simulation. For information about the code
generation limitations, see “Limitations for Block Parameter Tunability in
Generated Code” on page 34-120.

For information about external mode, see “External Mode Simulations for
Parameter Tuning and Signal Monitoring” on page 58-2.

Tune parameters and monitor
signals with Simulink Real-
Time

If you have Simulink Real-Time, you can tune parameters and monitor signals
during execution of your real-time application. Make signals accessible and
parameters tunable by clearing optimizations and applying test points and
storage classes. See “Parameter Tuning with Simulink Real-Time Explorer”
(Simulink Real-Time).

Limitations
For information about limitations that apply to the tunability of parameters in the generated code, see
“Limitations for Block Parameter Tunability in Generated Code” on page 34-120.

See Also

Related Examples
• “Deploy Algorithm Model for Real-Time Rapid Prototyping” on page 65-2
• “Access Signal, State, and Parameter Data During Execution” on page 34-17
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Create Tunable Calibration Parameter in the Generated Code” on page 34-109
• “Switch Between Sets of Parameter Values During Simulation and Code Execution” on page 34-

159
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Access Signal, State, and Parameter Data During Execution
As you iteratively develop a model, you capture output signal and state data that model execution
generates. You also tune parameter values during execution to observe results on the outputs. You
can then base your design decisions upon analysis of these outputs. To access this signal, state, and
parameter data in a rapid prototyping environment, you can configure the generated code to store
the data in addressable memory.

By default, optimization settings make the generated code more efficient by eliminating unnecessary
signal storage and inlining the numeric values of block parameters. To generate code that instead
allocates addressable memory for this data, you can disable the optimizations or specify code
generation settings for individual data items.

Explore Example Model

Run a script that prepares the model rtwdemo_configrpinterface for this example.

prepare_rtwdemo_configrpinterface

This data is configured for code generation:

• Parameters UPPER, LOWER, K1, Table1, and Table2
• Signals In1, In2, In3, In4, and Out1
• States X (delay) and mode (data store memory write)

Open the example model, rtwdemo_configrpinterface.

rtwdemo_configrpinterface
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The model loads numeric MATLAB variables into the model workspace. The workspace variables set
some block parameters in the model. However, the Gain block in the model uses the literal value 2.

Disable Optimizations

1. In the model, clear the model configuration parameter Signal storage reuse. When you clear this
optimization and other optimizations such as Eliminate superfluous local variables (expression
folding), the generated code allocates memory for signal lines. Clearing Signal storage reuse
disables most of the other optimizations.

set_param('rtwdemo_configrpinterface','OptimizeBlockIOStorage','off')

2. Set the model configuration parameter Default parameter behavior to Tunable. When set to
Tunable, this configuration parameter causes the generated code to allocate memory for block
parameters and workspace variables.

set_param('rtwdemo_configrpinterface','DefaultParameterBehavior','Tunable')

3. Generate code.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of build procedure for: rtwdemo_configrpinterface

Build Summary
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Top model targets built:

Model                      Action                       Rebuild Reason                                    
==========================================================================================================
rtwdemo_configrpinterface  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 36.843s

4. In the code generation report, view the file rtwdemo_configrpinterface.h. This header file
defines a structure type that contains signal data. The structure contains fields that each represent a
signal line in the model. For example, the output signal of the Gain block, whose name is Gain,
appears as the field Gain.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.h');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    'B_rtwdemo_configrpinterface_T;',1,1)

/* Block signals (default storage) */
typedef struct {
  real_T Delay;                        /* '<Root>/Delay' */
  real_T Table2;                       /* '<Root>/Table2' */
  real_T Table1;                       /* '<Root>/Table1' */
  real_T Gain;                         /* '<Root>/Gain' */
  boolean_T RelOp1;                    /* '<Root>/RelOp1' */
  boolean_T RelOp2;                    /* '<Root>/RelOp2' */
  boolean_T LogOp;                     /* '<Root>/LogOp' */
  boolean_T DataStoreRead;             /* '<Root>/Data Store Read' */
} B_rtwdemo_configrpinterface_T;

The file defines a structure type that contains block parameter data. For example, the Gain
parameter of the Gain block appears as the field Gain_Gain. The other fields of the structure
represent other block parameters and workspace variables from the model, including initial
conditions for signals and states.

rtwdemodbtype(file,'/* Parameters (default storage) */',...
    '/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */
struct P_rtwdemo_configrpinterface_T_ {
  Table1_Type Table1;                  /* Variable: Table1
                                        * Referenced by: '<Root>/Table1'
                                        */
  Table2_Type Table2;                  /* Variable: Table2
                                        * Referenced by: '<Root>/Table2'
                                        */
  real_T LOWER;                        /* Variable: LOWER
                                        * Referenced by: '<Root>/Constant2'
                                        */
  real_T UPPER;                        /* Variable: UPPER
                                        * Referenced by: '<Root>/Constant1'
                                        */
  real_T Gain_Gain;                    /* Expression: 2
                                        * Referenced by: '<Root>/Gain'
                                        */
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  real_T Delay_InitialCondition;       /* Expression: 0
                                        * Referenced by: '<Root>/Delay'
                                        */
  uint32_T Table2_maxIndex[2];         /* Computed Parameter: Table2_maxIndex
                                        * Referenced by: '<Root>/Table2'
                                        */
  boolean_T DataStoreMemory_InitialValue;
                             /* Computed Parameter: DataStoreMemory_InitialValue
                              * Referenced by: '<Root>/Data Store Memory'
                              */
};

5. View the file rtwdemo_configrpinterface_data.c. This source file allocates global memory
for a parameter structure and initializes the field values based on the parameter values in the model.

6. View the source file rtwdemo_configrpinterface.c. The code allocates global memory for a
structure variable that contains signal data.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    'B_rtwdemo_configrpinterface_T rtwdemo_configrpinterface_B;',1,1)

/* Block signals (default storage) */
B_rtwdemo_configrpinterface_T rtwdemo_configrpinterface_B;

The code algorithm in the model step function calculates the signal values. It then assigns these
values to the fields of the signal structure. To perform the calculations, the algorithm uses the
parameter values from the fields of the parameter structure.

Exclude Data Items from Optimizations

When you want to select code generation optimizations such as Signal storage reuse, you can
preserve individual data items from the optimizations. The generated code then allocates addressable
memory for the items.

Select the optimizations that you previously cleared.

set_param('rtwdemo_configrpinterface','OptimizeBlockIOStorage','on')
set_param('rtwdemo_configrpinterface','LocalBlockOutputs','on')
set_param('rtwdemo_configrpinterface','DefaultParameterBehavior','Inlined')

1. In the C Code tab, select Code Interface > Individual Element Code Mappings.

2. In the Code Mappings editor, inspect the Signals/States tab.

3. In the model, select the output signal of the Gain block.

4. Pause on the ellipsis that appears above or below the signal line to open the action bar. Click the
Add Signal button. In the Code Mappings editor, the Signals node expands and lists the signal that
you added.

cm = coder.mapping.api.get('rtwdemo_configrpinterface');
gain_ports = get_param('rtwdemo_configrpinterface/Gain','PortHandles');
gain_outPort = gain_ports.Outport;
addSignal(cm,gain_outPort);
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5. Apply the default storage class for Outports to the signal by setting Storage Class to Model
default.

setSignal(cm,gain_outPort,'StorageClass','Model default','Identifier','Gain');

6. In the model, select the Gain block.

7. In the Property Inspector, set the gain value to the model workspace parameter object K1.

8. In the Code Mappings editor, on the Parameters tab, expand Model Parameters.

9. Select parameter K1. Apply a storage class other than Auto by setting Storage class. For
example, use the storage class Model default. By using Model default, K1 acquires the default
storage class specified for model parameters, Default, and appears as a field of the global
parameters structure.

set_param('rtwdemo_configrpinterface/Gain','Gain','K1');
setModelParameter(cm,'K1','StorageClass','Model default');

10. Generate code.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of build procedure for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action                       Rebuild Reason                   
=========================================================================================
rtwdemo_configrpinterface  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.669s

11. In the code generation report, view the file rtwdemo_configrpinterface.h. The structure
that contains signal data now defines only one field, Gain, which represents the test-pointed output
of the Gain block.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.h');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    'B_rtwdemo_configrpinterface_T;',1,1)

/* Block signals (default storage) */
typedef struct {
  real_T Gain;                         /* '<Root>/Gain' */
} B_rtwdemo_configrpinterface_T;

The structure that contains block parameter data defines one field, K1, which represents the
parameter object K1.

rtwdemodbtype(file,'/* Parameters (default storage) */',...
    '/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */

 Access Signal, State, and Parameter Data During Execution

34-21



struct P_rtwdemo_configrpinterface_T_ {
  int8_T K1;                           /* Variable: K1
                                        * Referenced by: '<Root>/Gain'
                                        */
};

Access Data Through Generated Interfaces

You can configure the generated code to contain extra code and files so that you can access model
data through standardized interfaces. For example, use the C API to log signal data and tune
parameters during execution.

Copy this custom source code into a file named ex_myHandCode.c in your current folder.

#include "ex_myHandHdr.h"
 
#define paramIdx 0 /* Index of the target parameter, 
determined by inspecting the array of structures generated by the C API. */
#define sigIdx 0 /* Index of the target signal, 
determined by inspecting the array of structures generated by the C API. */
 
void tuneFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr)
{
    /* Take action with the parameter value only at 
       the beginning of simulation and at the 5-second mark. */
    if (*tPtr == 0 || *tPtr == 5) {
        
        /* Local variables to store information extracted from 
           the model mapping information (mmi). */
        void** dataAddrMap;
        const rtwCAPI_DataTypeMap *dataTypeMap;
        const rtwCAPI_ModelParameters *params;
        int_T addrIdx;
        uint16_T dTypeIdx;
        uint8_T slDataType;
        
        /* Use built-in C API macros to extract information. */
        dataAddrMap = rtwCAPI_GetDataAddressMap(mmi);
        dataTypeMap = rtwCAPI_GetDataTypeMap(mmi);
        params = rtwCAPI_GetModelParameters(mmi);
        addrIdx = rtwCAPI_GetModelParameterAddrIdx(params,paramIdx);
        dTypeIdx =  rtwCAPI_GetModelParameterDataTypeIdx(params,paramIdx);
        slDataType = rtwCAPI_GetDataTypeSLId(dataTypeMap, dTypeIdx);
        
        /* Handle data types 'double' and 'int8'. */
        switch (slDataType) {
            
            case SS_DOUBLE: {
                real_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                /* At the 5-second mark, increment the parameter value by 1. */
                if (*tPtr == 5) {
                    (*dataAddress)++;
                }
                printf("Parameter value is %f\n", *dataAddress);
                break;
            }
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            case SS_INT8: {
                int8_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                if (*tPtr == 5) {
                    (*dataAddress)++;
                }
                printf("Parameter value is %i\n", *dataAddress);
                break;
            }
        }
    }
}
 
void logFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr)
{
    /* Take action with the signal value only when 
       the simulation time is an integer value. */
    if (*tPtr-(int_T)*tPtr == 0) {
        
        /* Local variables to store information extracted from 
           the model mapping information (mmi). */
        void** dataAddrMap;
        const rtwCAPI_DataTypeMap *dataTypeMap;
        const rtwCAPI_Signals *sigs;
        int_T addrIdx;
        uint16_T dTypeIdx;
        uint8_T slDataType;
        
        /* Use built-in C API macros to extract information. */
        dataAddrMap = rtwCAPI_GetDataAddressMap(mmi);
        dataTypeMap = rtwCAPI_GetDataTypeMap(mmi);
        sigs = rtwCAPI_GetSignals(mmi);
        addrIdx = rtwCAPI_GetSignalAddrIdx(sigs,sigIdx);
        dTypeIdx =  rtwCAPI_GetSignalDataTypeIdx(sigs,sigIdx);
        slDataType = rtwCAPI_GetDataTypeSLId(dataTypeMap, dTypeIdx);
        
        /* Handle data types 'double' and 'single'. */
        switch (slDataType) {
            
            case SS_DOUBLE: {
                real_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                printf("Signal value is %f\n", *dataAddress);
                break;
            }
            
            case SS_SINGLE: {
                real32_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                printf("Signal value is %f\n", *dataAddress);
                break;
            }
        }
    }
}

2. Copy this custom header code into a file named ex_myHandHdr.h in your current folder.
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#include <stdio.h>
#include <string.h>
#include <math.h>
/* Include rtw_modelmap.h for definitions of C API macros. */
#include "rtw_modelmap.h"
#include "builtin_typeid_types.h"
#include "rtwtypes.h"
void tuneFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr);
void logFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr);

These files use the C API to access signal and parameter data in the code that you generate from the
example model.

3. Set model configuration parameters Header file and Source files to #include
"ex_myHandHdr.h" and ex_myHandCode.c, respectively.

set_param('rtwdemo_configrpinterface','CustomHeaderCode','#include "ex_myHandHdr.h"')
set_param('rtwdemo_configrpinterface','CustomSource','ex_myHandCode.c')

4. Select model configuration parameter MAT-file Logging. The generated executable runs only until
the simulation stop time (which you set in the model configuration parameters).

set_param('rtwdemo_configrpinterface','MatFileLogging','on')

5. Select C API model configuration parameters parameters, signals, states, and root-level I/O.

set_param('rtwdemo_configrpinterface','RTWCAPIParams','on')
set_param('rtwdemo_configrpinterface','RTWCAPISignals','on')
set_param('rtwdemo_configrpinterface','RTWCAPIStates','on')
set_param('rtwdemo_configrpinterface','RTWCAPIRootIO','on')

6. Load the Custom Code block library.

custcode

7. Add a System Outputs block to the model.
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add_block('custcode/System Outputs','rtwdemo_configrpinterface/System Outputs')

8. In the System Outputs block dialog box, set System Outputs Function Execution Code to this
code:

{
rtwdemo_configrpinterface_U.input2++;
rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);
tuneFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
}

9. In the block dialog box, set System Outputs Function Exit Code to this code:

{
rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);
logFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
}

Alternatively, to configure the System Outputs block, at the command prompt, use these commands:

temp.TLCFile = 'custcode';
temp.Location = 'System Outputs Function';
temp.Middle = sprintf(['{\nrtwdemo_configrpinterface_U.input2++;'...
    '\nrtwCAPI_ModelMappingInfo *MMI = '...
    '&(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);'...
    '\ntuneFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));\n}']);
temp.Bottom = sprintf(['{\nrtwCAPI_ModelMappingInfo *MMI = '...
    '&(rtmGetDataMapInfo(rtwdemo_configrpinterface_M).mmi);'...
    '\nlogFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));\n}']);
set_param('rtwdemo_configrpinterface/System Outputs','RTWdata',temp)

10. Generate code.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of build procedure for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action                       Rebuild Reason                   
=========================================================================================
rtwdemo_configrpinterface  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 17.796s

11. In the code generation report, view the interface file rtwdemo_configrpinterface_capi.c.
This file initializes the arrays of structures that you can use to interact with data items through the C
API. For example, in the array of structures rtBlockSignals, the first structure (index 0) describes
the test-pointed output signal of the Gain block in the model.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface_capi.c');
rtwdemodbtype(file,'/* Block output signal information */',...
    '/* Individual block tuning',1,0)

/* Block output signal information */
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static const rtwCAPI_Signals rtBlockSignals[] = {
  /* addrMapIndex, sysNum, blockPath,
   * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex
   */
  { 0, 0, TARGET_STRING("rtwdemo_configrpinterface/Gain"),
    TARGET_STRING(""), 0, 0, 0, 0, 0 },

  {
    0, 0, (NULL), (NULL), 0, 0, 0, 0, 0
  }
};

The fields of the structure, such as addrMapIndex, indicate indices into other arrays of structures,
such as rtDataAddrMap, that describe the characteristics of the signal. These characteristics
include the address of the signal data (a pointer to the data), the numeric data type, and the
dimensions of the signal.

12. In the file rtwdemo_configrpinterface.c, view the code algorithm in the model step
function. The algorithm first executes the code that you specified in the System Outputs block.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* user code (Output function Body) */',...
    '/* Logic: ''<Root>/LogOp'' incorporates:',1,0)

  /* user code (Output function Body) */

  /* System '<Root>' */
  {
    rtwdemo_configrpinterface_U.input2++;
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo
      (rtwdemo_configrpinterface_M).mmi);
    tuneFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
  }

  /* DataStoreWrite: '<Root>/Data Store Write' incorporates:
   *  Constant: '<Root>/Constant1'
   *  Constant: '<Root>/Constant2'
   *  Inport: '<Root>/In1'
   *  Logic: '<Root>/LogOp'
   *  RelationalOperator: '<Root>/RelOp1'
   *  RelationalOperator: '<Root>/RelOp2'
   */
  mode = ((rtwdemo_configrpinterface_U.In1 > 10.0) ||
          (rtwdemo_configrpinterface_U.In1 < -10.0));

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In2'
   *  Lookup_n-D: '<Root>/Table1'
   */
  rtwdemo_configrpinterface_B.Gain = (real_T)rtwdemo_configrpinterface_P.K1 *
    look1_binlc(rtwdemo_configrpinterface_U.input2, rtCP_Table1_bp01Data,
                rtCP_Table1_tableData, 10U);

  /* Switch: '<Root>/Switch' incorporates:
   *  DataStoreRead: '<Root>/Data Store Read'
   */
  if (mode) {
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    /* Outport: '<Root>/Out1' */
    output = rtwdemo_configrpinterface_B.Gain;
  } else {
    /* Outport: '<Root>/Out1' incorporates:
     *  UnitDelay: '<Root>/Delay'
     */
    output = rtwdemo_configrpinterface_DW.X;
  }

  /* End of Switch: '<Root>/Switch' */

  /* Lookup_n-D: '<Root>/Table2' incorporates:
   *  Inport: '<Root>/In3'
   *  Inport: '<Root>/In4'
   */
  rtwdemo_configrpinterface_DW.X = look2_binlc(rtwdemo_configrpinterface_U.In3,
    rtwdemo_configrpinterface_U.In4, rtCP_Table2_bp01Data, rtCP_Table2_bp02Data,
    rtCP_Table2_tableData, rtCP_Table2_maxIndex, 3U);

  /* user code (Output function Trailer) */

  /* System '<Root>' */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo
      (rtwdemo_configrpinterface_M).mmi);
    logFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
  }

  /* Matfile logging */
  rt_UpdateTXYLogVars(rtwdemo_configrpinterface_M->rtwLogInfo,
                      (&rtwdemo_configrpinterface_M->Timing.taskTime0));

  /* signal main to stop simulation */
  {                                    /* Sample time: [1.0s, 0.0s] */
    if ((rtmGetTFinal(rtwdemo_configrpinterface_M)!=-1) &&
        !((rtmGetTFinal(rtwdemo_configrpinterface_M)-
           rtwdemo_configrpinterface_M->Timing.taskTime0) >
          rtwdemo_configrpinterface_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(rtwdemo_configrpinterface_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
  if (!(++rtwdemo_configrpinterface_M->Timing.clockTick0)) {
    ++rtwdemo_configrpinterface_M->Timing.clockTickH0;
  }

  rtwdemo_configrpinterface_M->Timing.taskTime0 =
    rtwdemo_configrpinterface_M->Timing.clockTick0 *
    rtwdemo_configrpinterface_M->Timing.stepSize0 +
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    rtwdemo_configrpinterface_M->Timing.clockTickH0 *
    rtwdemo_configrpinterface_M->Timing.stepSize0 * 4294967296.0;
}

/* Model initialize function */
void rtwdemo_configrpinterface_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)rtwdemo_configrpinterface_M, 0,
                sizeof(RT_MODEL_rtwdemo_configrpinte_T));
  rtmSetTFinal(rtwdemo_configrpinterface_M, 10.0);
  rtwdemo_configrpinterface_M->Timing.stepSize0 = 1.0;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    rtwdemo_configrpinterface_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
    rtliSetLogT(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogX(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogXFinal(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(rtwdemo_configrpinterface_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(rtwdemo_configrpinterface_M->rtwLogInfo, 0);
    rtliSetLogMaxRows(rtwdemo_configrpinterface_M->rtwLogInfo, 1000);
    rtliSetLogDecimation(rtwdemo_configrpinterface_M->rtwLogInfo, 1);
    rtliSetLogY(rtwdemo_configrpinterface_M->rtwLogInfo, "");
    rtliSetLogYSignalInfo(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
    rtliSetLogYSignalPtrs(rtwdemo_configrpinterface_M->rtwLogInfo, (NULL));
  }

  /* block I/O */
  (void) memset(((void *) &rtwdemo_configrpinterface_B), 0,
                sizeof(B_rtwdemo_configrpinterface_T));

  /* Storage classes */
  output = 0.0;

  /* states (dwork) */
  (void) memset((void *)&rtwdemo_configrpinterface_DW, 0,
                sizeof(DW_rtwdemo_configrpinterface_T));

  /* exported global states */
  mode = false;

  /* external inputs */
  (void)memset(&rtwdemo_configrpinterface_U, 0, sizeof
               (ExtU_rtwdemo_configrpinterfac_T));
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  /* Initialize DataMapInfo substructure containing ModelMap for C API */
  rtwdemo_configrpinterface_InitializeDataMapInfo();

  /* Matfile logging */
  rt_StartDataLoggingWithStartTime(rtwdemo_configrpinterface_M->rtwLogInfo, 0.0,
    rtmGetTFinal(rtwdemo_configrpinterface_M),
    rtwdemo_configrpinterface_M->Timing.stepSize0, (&rtmGetErrorStatus
    (rtwdemo_configrpinterface_M)));

  /* Start for DataStoreMemory: '<Root>/Data Store Memory' */
  mode = false;

  /* InitializeConditions for Lookup_n-D: '<Root>/Table2' incorporates:
   *  UnitDelay: '<Root>/Delay'
   */
  rtwdemo_configrpinterface_DW.X = 0.0;
}

/* Model terminate function */
void rtwdemo_configrpinterface_terminate(void)
{
  /* (no terminate code required) */
}

This code first perturbs the input signal input2 by incrementing the value of the signal each time the
step function executes. The code then uses the built-in macro rtmGetDataMapInfo to extract
model mapping information from the model data structure rtwdemo_configrpinterface_M. The
pointer MMI points to the extracted mapping information, which allows the functions tuneFcn and
logFcn to access the information contained in the arrays of structures that the C API file
rtwdemo_configrpinterface_capi.c defines.

13. View the function tuneFcn in the file ex_myHandCode.c. This function uses the C API (through
the model mapping information mmi) and a pointer to the simulation time to print the value of the
parameter K1 at specific times during code execution. When the simulation time reaches 5 seconds,
the function changes the parameter value in memory. By using a switch case block, the function
can access the parameter data whether the data type is int8 or double.

14. View the code algorithm in the model step function again. Near the end of the function, the
algorithm executes the code that you specified in the System Outputs block. This code calls the
function logFcn.

rtwdemodbtype(file,'/* user code (Output function Trailer) */',...
    '/* Matfile logging */',1,0)

  /* user code (Output function Trailer) */

  /* System '<Root>' */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo
      (rtwdemo_configrpinterface_M).mmi);
    logFcn(MMI, rtmGetTPtr(rtwdemo_configrpinterface_M));
  }
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15. View the function logFcn in the file ex_myHandCode.c. The function uses the C API to print the
value of the test-pointed signal. The function can access the signal data whether the data type is
single or double.

16. At the command prompt, run the generated executable rtwdemo_configrpinterface.exe.

system('rtwdemo_configrpinterface')

The parameter and signal values appear in the Command Window output.

For more information about data interfaces, including the C API, see “Calibration and Measurement”.

See Also
Simulink.Parameter | Simulink.Signal | Simulink.Signal

Related Examples
• “Data Structures in the Generated Code” on page 34-31
• “Preserve Variables in Generated Code” on page 34-2
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Exchange Data Between Generated and External Code Using C API” on page 60-2
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Data Structures in the Generated Code
The code generator organizes the data used by the model in data structures. For each model, the
code generator stores data, such as signals and states, in global structures that are also referred to
as standard data structures. Use these data structures to access the data in the generated code.

Real-time model (rtModel) data structure is a top level data structure that contains instance-specific
data, which is used by the model for reusable functions. The code generator uses this data structure
for only multi-instance code generation.

Standard Data Structures
In a model, root-level Inport and Outport blocks represent the primary inputs and outputs of the
block algorithm. By default, the code generator aggregates these blocks into standard structures that
store input and output data.

Signal lines, block parameters, states, and other model data appear in the generated code as fields of
standard structures. For general information, see “How Generated Code Stores Internal Signal, State,
and Parameter Data” on page 34-49.

The table shows some common data structures in the generated code. The name of the structure type
and, if applicable, structure variable in the code that you generate from a model depends on the
model settings. Regardless of the settings, the name of the structure type in the code contains the
short name from the Short Name of Structure Type column in the table.

Data Structures Generated for a Model

Short Name of Structure Type Data Represented in the Structure
ExtU Data from root Inport blocks
ExtY Data from root Outport blocks
B Block output signals
ConstB Block outputs that have constant values
P Block parameters
ConstP Constant parameters
DW Discrete block states
XDis Status of enabled subsystems
InstP Parameter arguments
SharedDSM Shared local data stores

You can exclude data from appearing in these structures by using:

• Direct application of storage classes. For example, you can use storage classes to represent
signals, tunable parameters, and states as individual global variables. For more information, see
“C Code Generation Configuration for Model Interface Elements” on page 33-2.

• Configuration parameters, such as those on the Optimization pane in the Configuration
Parameters dialog box. You can adjust these configuration parameters to control the default
representation of data. For more information, see “Model Configuration Parameters: Code
Generation Optimization”.

 Data Structures in the Generated Code

34-31



Real-Time Model Data Structure
To access the fields of an S-function's simulation data structure (SimStruct), the Simulink software
provides a set of functions. The code generator replaces SimStruct with an optimized real-time
model (rtModel) data structure.

Code generation by using the GRT and ERT system target files uses the real-time model data
structure (rtModel). This structure encapsulates model-specific information in a much more
compact form than the simulation structure SimStruct. Depending on the model, the model-specific
information includes data such as internal data for reusable functions and error state.

When you set Code interface packaging to Reusable function, the code generator packages
model data (such as block I/O, Dwork, and parameters) into the real-time model data structure. The
code generator passes the real-time model structure by reference to generated model entry-point
functions. If you set Pass root-level I/O as to Part of model data structure, the code
generator packages root-level model input and output into the real-time model data structure.

Efficient capabilities of the generated code depend on generation of rtModel rather than
SimStruct, including:

• Integer absolute and elapsed timing services
• Independent timers for asynchronous tasks
• Generation of improved C API code for signal, state, and parameter monitoring
• Pruning the data structure to minimize its size (ERT-derived system target files only)

The real-time model data structure is defined in the main.c or main.cpp file that is generated when
you build your model. For ERT models, if you clear the model configuration parameter Generate an
example main program, rtModel.h file is generated. The rtModel.h file contains #include
directives required by the rt_main.c or rt_cppclass_main.cpp static main program module. The
rt_main.c or rt_cppclass_main.cpp includes rtModel.h to access model-specific data
structures and entry points because the static main program module is not created at code
generation time.

The code generator provides a set of macros for accessing the rtModel data structure. These macros
are analogous to the ssSetxxx and ssGetxxx macros that S-functions use to access SimStruct
data, including noninlined S-functions compiled by the code generator.

Use the set of macros rtmGetxxx and rtmSetxxx to access the real-time model data structure.
These macros are used in the generated code as well as in the main.c or main.cpp module of your
external code. If you are customizing main.c or main.cpp (either a static or a generated file), use
rtmGetxxx and rtmSetxxx instead of the ssSetxxx and ssGetxxx macros.

Usage of rtmGetxxx and rtmSetxxx macros is the same as for the ssSetxxx and ssGetxxx
versions, except that you replace SimStruct S by real-time model data structure rtM. This table
lists rtmGetxxx and rtmSetxxx macros that are used in grt_main.c and grt_main.cpp.
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Macros for Accessing the Real-Time Model Data Structure

rtm Macro Syntax Description
rtmGetdX(rtm) Get the derivatives of block continuous states
rtmGetOffsetTimePtr(RT_MDL rtM) Return the pointer to vector that stores sample time

offsets of the model associated with rtM
rtmGetNumSampleTimes(RT_MDL rtM) Get the number of sample times of a block
rtmGetPerTaskSampleHitsPtr(RT_MDL) Return a pointer to NumSampleTime ×

NumSampleTime matrix
rtmGetRTWExtModeInfo(RT_MDL rtM) Return an external mode information data structure of

the model (used by code generator only for external
mode)

rtmGetRTWLogInfo(RT_MDL) Return a data structure used by code generator
logging (used by code generator only)

rtmGetRTWRTModelMethodsInfo(RT_MDL) Return a data structure of real-time model methods
information (used by code generator only)

rtmGetRTWSolverInfo(RT_MDL) Return data structure containing model solver
information (used by code generator only)

rtmGetSampleHitPtr(RT_MDL) Return a pointer to Sample Hit flag vector
rtmGetSampleTime(RT_MDL rtM, int TID) Get task sample time
rtmGetSampleTimePtr(RT_MDL rtM) Get pointer to a task sample time
rtmGetSampleTimeTaskIDPtr(RT_MDL rtM) Get pointer to a task ID
rtmGetSimTimeStep(RT_MDL) Return simulation step type ID (MINOR_TIME_STEP,

MAJOR_TIME_STEP)
rtmGetStepSize(RT_MDL) Return the fundamental step size of the model
rtmGetT(RT_MDL,t) Get the current simulation time
rtmSetT(RT_MDL,t) Set the time of the next sample hit
rtmGetTaskTime(RT_MDL,tid) Get the current time for the current task
rtmGetTFinal(RT_MDL) Get the simulation stop time
rtmSetTFinal(RT_MDL,finalT) Set the simulation stop time
rtmGetTimingData(RT_MDL) Return a data structure used by timing engine of the

model (used by code generator only)
rtmGetTPtr(RT_MDL) Return a pointer to the current time
rtmGetTStart(RT_MDL) Get the simulation start time
rtmIsContinuousTask(rtm) Determine whether a task is continuous
rtmIsMajorTimeStep(rtm) Determine whether the simulation is in a major step
rtmIsSampleHit(RT_MDL,tid) Determine whether the sample time is hit
rtmGetErrorStatus(rtm) Get the current error status
rtmSetErrorStatus(rtm,val) Set the current error status
rtmGetErrorStatusPointer(rtm) Return a pointer to the current error status
rtmGetStopRequested(rtm) Return whether a stop is requested
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rtm Macro Syntax Description
rtmGetBlockIO(rtm) Get the block I/O data structure
rtmSetBlockIO(rtm,val) Set the block I/O data structure
rtmGetContStates(rtm) Get the continuous states data structure
rtmSetContStates(rtm,val) Set the continuous states data structure
rtmGetDefaultParam(rtm) Get the default parameters data structure
rtmSetDefaultParam(rtm,val) Set the default parameters data structure
rtmGetPrevZCSigState(rtm) Get the previous zero-crossing signal state data

structure
rtmSetPrevZCSigState(rtm,val) Set the previous zero-crossing signal state data

structure
rtmGetRootDWork(rtm) Get the DWork data structure
rtmSetRootDWork(rtm,val) Set the DWork data structure
rtmGetU(rtm) Get the root inputs data structure (when root inputs

are passed as part of the model data structure)
rtmSetU(rtm,val) Set the root inputs data structure (when root inputs

are passed as part of the model data structure)
rtmGetY(rtm) Get the root outputs data structure (when root outputs

are passed as part of the model data structure)
rtmSetY(rtm,val) Set the root outputs data structure (when root outputs

are passed as part of the model data structure)

For more information, see “SimStruct Macros and Functions Listed by Usage”.

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment” on page 34-35
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Access Signal, State, and Parameter Data During Execution” on page 34-17
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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How Generated Code Exchanges Data with an Environment
To use the code that you generate from a model, you call the generated entry-point functions such as
step and initialize. The environment in which you call these functions must provide input signal
data and, depending on your application, scheduling information. The generated algorithm then
calculates output data that the calling environment can use. The environment and the algorithm can
exchange this data through global variables or through formal parameters (arguments).

The set of input and output data and the exchange mechanisms constitute the interfaces of the entry-
point functions. When you understand the default interfaces and how to control them, you can:

• Write code that calls the generated code.
• Generate reusable (reentrant) code that you can call multiple times in a single application.
• Integrate the generated code with other, external code in your application.

In a model, root-level Inport and Outport blocks represent the primary inputs and outputs of the
block algorithm. By default, the code generator aggregates these blocks into standard structures that
store input and output data.

For information about how the generated code stores internal data, which does not participate in the
model interface, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on
page 34-49.

Data Interfaces in the Generated Code
This example shows how the generated code exchanges data with an environment.

Explore Example Model

Open the example model rtwdemo_roll.

open_system('rtwdemo_roll')
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At the root level, the model has a number of Inport blocks and one Outport block.

In the model, set Configuration Parameters > Code Generation > System target file to
grt.tlc.

set_param('rtwdemo_roll','SystemTargetFile','grt.tlc')

Inspect the setting for Configuration Parameters > Code Generation > Interface > Code
interface packaging. The setting Nonreusable function means that the generated code is not
reusable (not reentrant).

For this example, to generate simpler code, clear the Configuration Parameters > Code
Generation > Interface > Advanced parameters > Mat-file logging.

set_param('rtwdemo_roll','MatFileLogging','off')

Generate Nonreusable Code

Generate code from the model.

slbuild('rtwdemo_roll')

### Starting build procedure for: rtwdemo_roll
### Successful completion of build procedure for: rtwdemo_roll

Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                                    
=============================================================================================
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rtwdemo_roll  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.908s

Inspect the file rtwdemo_roll.h. The file defines a structure type that represents input data and a
type that represents output data.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,...
    '/* External inputs (root inport signals with default storage) */',...
    '} ExtY_rtwdemo_roll_T;',1,1)

/* External inputs (root inport signals with default storage) */
typedef struct {
  real32_T Phi;                        /* '<Root>/Phi' */
  real32_T Psi;                        /* '<Root>/Psi' */
  real32_T Rate_FB;                    /* '<Root>/Rate_FB' */
  real32_T TAS;                        /* '<Root>/TAS' */
  boolean_T AP_Eng;                    /* '<Root>/AP_Eng' */
  boolean_T HDG_Mode;                  /* '<Root>/HDG_Mode' */
  real32_T HDG_Ref;                    /* '<Root>/HDG_Ref' */
  real32_T Turn_Knob;                  /* '<Root>/Turn_Knob' */
} ExtU_rtwdemo_roll_T;

/* External outputs (root outports fed by signals with default storage) */
typedef struct {
  real32_T Ail_Cmd;                    /* '<Root>/Ail_Cmd' */
} ExtY_rtwdemo_roll_T;

Each field corresponds to an Inport or Outport block at the root level of the model. The name of each
field derives from the name of the block.

The file also defines a structure type, the real-time model data structure, whose single field stores a
run-time indication of whether the generated code has encountered an error during execution.

rtwdemodbtype(file,'/* Real-time Model Data Structure */',...
    '/* Block states (default storage) */',1,0)

/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
  const char_T *errorStatus;
};

When you modify model configuration parameters to suit your application, this structure can also
contain other data that pertain to the entire model, such as scheduling information.

For the structure type that represents the real-time model data structure, the file
rtwdemo_roll_types.h creates an alias (typedef) that the generated code later uses to allocate
memory for the structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll_types.h');
rtwdemodbtype(file,'/* Forward declaration for rtModel */',...
    'RT_MODEL_rtwdemo_roll_T;',1,1)
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/* Forward declaration for rtModel */
typedef struct tag_RTM_rtwdemo_roll_T RT_MODEL_rtwdemo_roll_T;

Using these structure types, the file rtwdemo_roll.c defines (allocates memory for) global
structure variables that store input and output data for the generated algorithm. The file also defines
variables that represent the real-time model data structure and a pointer to the structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,...
    '/* External inputs (root inport signals with default storage) */',...
    '= &rtwdemo_roll_M_;',1,1)

/* External inputs (root inport signals with default storage) */
ExtU_rtwdemo_roll_T rtwdemo_roll_U;

/* External outputs (root outports fed by signals with default storage) */
ExtY_rtwdemo_roll_T rtwdemo_roll_Y;

/* Real-time model */
static RT_MODEL_rtwdemo_roll_T rtwdemo_roll_M_;
RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M = &rtwdemo_roll_M_;

The file rtwdemo_roll.h declares these structure variables. Your external code can include
(#include) this file, whose general name is model.h where model is the name of the model, to
access data that participate in the model interface.

In rtwdemo_roll.c, the model step function, which represents the primary model algorithm, uses
a void void interface (without arguments).

rtwdemodbtype(file,...
    '/* Model step function */','void rtwdemo_roll_step(void)',1,1)

/* Model step function */
void rtwdemo_roll_step(void)

In the function definition, the algorithm reads input data and writes output data by directly accessing
the global structure variables. For example, near the end of the algorithm, the code for the
EngSwitch block reads the value of the AP_Eng field (which represents an input) and, based on that
value, conditionally writes a constant value to the Ail_Cmd field (which represents an output).

rtwdemodbtype(file,'if (rtwdemo_roll_U.AP_Eng) {','      }',1,1)

  if (rtwdemo_roll_U.AP_Eng) {
    /* Outputs for Atomic SubSystem: '<Root>/BasicRollMode' */
    /* Saturate: '<S1>/CmdLimit' */
    if (rtwdemo_roll_Y.Ail_Cmd > 15.0F) {
      /* Sum: '<S1>/Sum2' incorporates:
       *  Outport: '<Root>/Ail_Cmd'
       */
      rtwdemo_roll_Y.Ail_Cmd = 15.0F;
    } else if (rtwdemo_roll_Y.Ail_Cmd < -15.0F) {
      /* Sum: '<S1>/Sum2' incorporates:
       *  Outport: '<Root>/Ail_Cmd'
       */
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      rtwdemo_roll_Y.Ail_Cmd = -15.0F;
    }

    /* End of Saturate: '<S1>/CmdLimit' */
    /* End of Outputs for SubSystem: '<Root>/BasicRollMode' */
  } else {
    /* Sum: '<S1>/Sum2' incorporates:
     *  Constant: '<Root>/Zero'
     *  Outport: '<Root>/Ail_Cmd'
     */
    rtwdemo_roll_Y.Ail_Cmd = 0.0F;
  }

  /* End of Switch: '<Root>/EngSwitch' */
}

/* Model initialize function */
void rtwdemo_roll_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_roll_M, (NULL));

  /* states (dwork) */
  (void) memset((void *)&rtwdemo_roll_DW, 0,
                sizeof(DW_rtwdemo_roll_T));

  /* external inputs */
  (void)memset(&rtwdemo_roll_U, 0, sizeof(ExtU_rtwdemo_roll_T));

  /* external outputs */
  rtwdemo_roll_Y.Ail_Cmd = 0.0F;

  /* SystemInitialize for Atomic SubSystem: '<Root>/RollAngleReference' */
  /* InitializeConditions for UnitDelay: '<S4>/FixPt Unit Delay1' */
  rtwdemo_roll_DW.FixPtUnitDelay1_DSTATE = 0.0F;

  /* End of SystemInitialize for SubSystem: '<Root>/RollAngleReference' */

  /* SystemInitialize for Atomic SubSystem: '<Root>/BasicRollMode' */
  /* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_DW.Integrator_DSTATE = 0.0F;
  rtwdemo_roll_DW.Integrator_PrevResetState = 0;

  /* End of SystemInitialize for SubSystem: '<Root>/BasicRollMode' */
}

/* Model terminate function */
void rtwdemo_roll_terminate(void)
{
  /* (no terminate code required) */
}

Due to the void void interface and the direct data access, the function is not reentrant. If you call
the function multiple times in an application, each call reads and writes input and output data to the
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same global structure variables, resulting in data corruption and unintentional interaction between
the calls.

The model initialization function, rtwdemo_roll_initialize, initializes input and output data to
zero. The function also initializes the error status. The function directly accesses the global variables,
which means the function is not reentrant.

rtwdemodbtype(file,'/* Model initialize function */',...
    'rtmSetErrorStatus(rtwdemo_roll_M, (NULL));',1,1)

/* Model initialize function */
void rtwdemo_roll_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_roll_M, (NULL));

rtwdemodbtype(file,'  /* external inputs */',...
    '/* SystemInitialize for Atomic SubSystem:',1,0)

  /* external inputs */
  (void)memset(&rtwdemo_roll_U, 0, sizeof(ExtU_rtwdemo_roll_T));

  /* external outputs */
  rtwdemo_roll_Y.Ail_Cmd = 0.0F;

Generate Reusable Code

You can configure the generated code as reentrant, which means that you can call the entry-point
functions multiple times in an application. With this configuration, instead of directly accessing global
variables, the entry-point functions exchange input, output, and other model data through formal
parameters (pointer arguments). With these pointer arguments, each call can read inputs and write
outputs to a set of separate global variables, preventing unintentional interaction between the calls.

In the model, set Configuration Parameters > Code Generation > Interface > Code interface
packaging to Reusable function.

set_param('rtwdemo_roll','CodeInterfacePackaging','Reusable function')

Generate code from the model.

slbuild('rtwdemo_roll')

### Starting build procedure for: rtwdemo_roll
### Successful completion of build procedure for: rtwdemo_roll

Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                   
============================================================================
rtwdemo_roll  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.643s

34 Data Representation in Simulink Coder

34-40



Now, in rtwdemo_roll.h, the real-time model data structure contains pointers to the error
indication, the input data, the output data, and additional data in the form of a DWork substructure
(which stores, for example, block states such as the state of a Discrete-Time Integrator block).

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,'/* Real-time Model Data Structure */',...
    '/* External data declarations for dependent source files */',1,0)

/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
  const char_T *errorStatus;
  ExtU_rtwdemo_roll_T *inputs;
  ExtY_rtwdemo_roll_T *outputs;
  DW_rtwdemo_roll_T *dwork;
};

To call the generated code multiple times in an application, your code must allocate memory for a
real-time model data structure per call. The file rtwdemo_roll.c defines a specialized function that
allocates memory for a new real-time model data structure and returns a pointer to the structure. The
function also allocates memory for the substructures that the fields in the model data structure point
to, such as the input and output structures.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Model data allocation function */',...
    'RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)',1,1)

/* Model data allocation function */
RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)

In rtwdemo_roll.c, the model step function accepts an argument that represents the real-time
model data structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,...
    '/* Model step function */','void rtwdemo_roll_step',1,1)

/* Model step function */
void rtwdemo_roll_step(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

In the function definition, the algorithm first extracts each pointer from the real-time model data
structure into a local variable.

rtwdemodbtype(file,...
    '*rtwdemo_roll_DW =','rtwdemo_roll_M->outputs;',1,1)

  DW_rtwdemo_roll_T *rtwdemo_roll_DW = rtwdemo_roll_M->dwork;
  ExtU_rtwdemo_roll_T *rtwdemo_roll_U = (ExtU_rtwdemo_roll_T *)
    rtwdemo_roll_M->inputs;
  ExtY_rtwdemo_roll_T *rtwdemo_roll_Y = (ExtY_rtwdemo_roll_T *)
    rtwdemo_roll_M->outputs;

Then, to access the input and output data stored in global memory, the algorithm interacts with these
local variables.
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rtwdemodbtype(file,'  if (rtwdemo_roll_U->AP_Eng) {',...
    '  /* End of Switch: ''<Root>/EngSwitch'' */',1,1)

  if (rtwdemo_roll_U->AP_Eng) {
    /* Outputs for Atomic SubSystem: '<Root>/BasicRollMode' */
    /* Saturate: '<S1>/CmdLimit' */
    if (rtwdemo_roll_Y->Ail_Cmd > 15.0F) {
      /* Sum: '<S1>/Sum2' incorporates:
       *  Outport: '<Root>/Ail_Cmd'
       */
      rtwdemo_roll_Y->Ail_Cmd = 15.0F;
    } else if (rtwdemo_roll_Y->Ail_Cmd < -15.0F) {
      /* Sum: '<S1>/Sum2' incorporates:
       *  Outport: '<Root>/Ail_Cmd'
       */
      rtwdemo_roll_Y->Ail_Cmd = -15.0F;
    }

    /* End of Saturate: '<S1>/CmdLimit' */
    /* End of Outputs for SubSystem: '<Root>/BasicRollMode' */
  } else {
    /* Sum: '<S1>/Sum2' incorporates:
     *  Constant: '<Root>/Zero'
     *  Outport: '<Root>/Ail_Cmd'
     */
    rtwdemo_roll_Y->Ail_Cmd = 0.0F;
  }

Similarly, the model initialization function accepts the real-time model data structure as an argument.

rtwdemodbtype(file,...
    '/* Model initialize function */','void rtwdemo_roll_initialize',1,1)

/* Model initialize function */
void rtwdemo_roll_initialize(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

Because each call that you make to an entry-point function interacts with a separate real-time model
data structure, you avoid unintentional interaction between the calls.

Configure Data Interface
To control the characteristics of the data interface in the generated code, see “Control Data and
Function Interface in Generated Code” on page 34-44.

See Also

Related Examples
• “Data Structures in the Generated Code” on page 34-31
• “What Is External Code Integration?” on page 56-2
• “Analyze the Generated Code Interface” on page 52-13
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• “Control Data and Function Interface in Generated Code” on page 34-44
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Control Data and Function Interface in Generated Code
To use the code that you generate from a model, you call generated entry-point functions such as
step and initialize. The calling environment and the generated functions exchange input and
output data through global variables or through formal parameters (arguments). This data and the
exchange mechanisms constitute the interfaces of the entry-point functions. For information about
the default interfaces for reentrant and nonreentrant models in the generated code, see “How
Generated Code Exchanges Data with an Environment” on page 34-35.

By controlling the interfaces that appear in the generated code, you can:

• Minimize the modifications that you must make to existing code.
• Generate stable interfaces that do not change or minimally change when you make changes to the

model.
• Generate code that exchanges data more efficiently (for example, by using pointers and pass-by-

reference arguments for nonscalar data).

Control Type Names, Field Names, and Variable Names of Standard I/O
Structures (Embedded Coder)
By default, for nonreentrant code, Inport blocks at the root level of the model appear in the generated
code as fields of a global structure variable. Similarly, Outport blocks appear in a different structure.
For reentrant code, depending on your setting for model configuration parameter Pass root-level
I/O, the code generator can also package input and output data into standard structures.

With Embedded Coder, you can control these names. See “Control Data Type Names in Generated
Code” on page 36-2.

Control Names of Generated Entry-Point Functions (Embedded Coder)
To use the generated code, you write code that calls generated entry-point functions. For example,
entry-point functions include model_step, model_initialize, and top-level functions generated
from an export-function model. To control the names of the model entry-point functions, use the Code
Mappings editor (requires Embedded Coder) to apply a combination of these techniques:

• On the Function Defaults tab, specify default naming rules for categories of entry-point
functions by applying function customization templates in the Code Mappings editor. With this
technique, a naming rule applies to functions in a category. For more information, see “Configure
Default Code Generation for Functions” on page 33-20.

• On the Functions tab, specify names for individual entry-point functions by either directly editing
the Function Name column or through a configuration dialog box opened from the Function
Preview column. Names that you specify override default naming rules specified by function
customization templates. For more information, see “Configure C Code Generation for Model
Entry-Point Functions” on page 33-112

Control Data Interface for Nonreentrant Code
When you set the model configuration parameter Code interface packaging to Nonreusable
function (the default), generated entry-point functions are not reentrant. Typically, the functions
exchange data with the calling environment through direct access to global variables.
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Configure Inport or Outport Block as Separate Global Variable

To remove the block from the standard I/O structures by creating a separate global variable, apply a
storage class, such as ExportedGlobal or ExportToFile, to the signal that the block represents.
You can configure a default storage class for categories of data elements, such as Inport blocks. As
you add such blocks to the model, they acquire the storage class that you specify. You can use the
Code Mappings editor also to configure individual blocks. You might do this if a model has just a few
data elements of a specific category or override the default configuration settings.

For an example, see “Design Data Interface by Configuring Inport and Outport Blocks”. For general
information about configuring data for code generation, see “C Code Generation Configuration for
Model Interface Elements” on page 33-2.

Configure Generated Code to Read or Write to Global Variables Defined by External Code

If your calling code already defines a global variable that you want the generated code to use as input
data or use to store output data, you can reuse the variable by preventing the code generator from
duplicating the definition. Apply a storage class to the corresponding Inport or Outport block in the
model. Choose a storage class that specifies an imported data scope, such as ImportedExtern or
ImportFromFile. For information about applying storage classes, see “C Code Generation
Configuration for Model Interface Elements” on page 33-2 and “Organize Parameter Data into a
Structure by Using Struct Storage Class” on page 33-68.

Package Multiple Inputs or Outputs into Custom Structure

You can configure a single Inport or Outport block to appear in the generated code as a custom
structure that contains multiple input or output signals. You can also configure the block to appear as
a substructure of the default I/O structures or as a separate structure variable.

Configure the block as a nonvirtual bus by using a Simulink.Bus object as the data type of the
block. If your external code defines the structure type, consider using the
Simulink.importExternalCTypes function to generate the bus object.

• To generate the bus signal as a substructure in the standard I/O structures, leave the block
storage class at the default setting, Auto. If you have Embedded Coder, in the Code Mappings
editor, on the Data Defaults tab, set the storage class for categories Inports and Outports to
Default.

• To generate the bus signal as a separate global structure variable, apply a storage class such as
ExportedGlobal or ExportToFile.

For more information about grouping signals into custom structures in the generated code, see
“Organize Data into Structures in Generated Code” on page 34-145.

Configure Inport or Outport Block as Function Call (Embedded Coder)

If your external code defines a function that returns input data for the generated code or accepts
output data that the generated code produces, you can configure an Inport or Outport block so that
the generated code calls the function instead of accessing a global variable. Apply the Embedded
Coder storage class GetSet. For more information, see “Access Data Through Functions with Storage
Class GetSet” on page 38-26.

Pass Inputs and Outputs Through Function Arguments (Embedded Coder)

With Embedded Coder, you can optionally configure the model step (execution) function to access
root-level input and output through arguments instead of directly reading and writing to global
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variables. Completely control the argument characteristics such as name, order, and passing
mechanism (by reference or by value). This level of configuration can help to integrate generated
code with your external code.

To pass inputs and outputs through arguments, in the Configure C Step Function interface dialog box,
select Configure arguments for Step function prototype. Each Inport and Outport block at the
root level of the model appears in the code as an argument of the execution function. For more
information, see “Configure C Code Generation for Model Entry-Point Functions” on page 33-112.

Configure Referenced Model Inputs and Outputs as Global Variables (void-void)

By default, for a nonreentrant referenced model, the generated code passes root-level input and
output through function arguments. A nonreentrant referenced model is one in which you set model
configuration parameter Total number of instances allowed per top model to One.

To pass this data through global variables instead (for a void-void interface), in the referenced
model, apply storage classes such as ExportedGlobal and ExportToFile to root-level Inport and
Outport blocks.

• To apply a default storage class to such blocks, use the Code Mapping Editor. With this technique,
as you add such blocks to the model, the blocks acquire the default storage class, preserving the
void-void interface. For more information, see “Configure Default Code Generation for Data” on
page 33-16.

• To override the default storage class, apply storage classes directly to individual blocks by using
the Code Mapping editor. See “C Code Generation Configuration for Model Interface Elements” on
page 33-2.

• For an example that requires Embedded Coder, see “Establish Data Ownership in a Model
Hierarchy” on page 35-10.

Control Data Interface for Reentrant Code
When you set Code interface packaging to Reusable function, generated entry-point functions
are reentrant. The functions exchange data with the calling environment through formal parameters
(arguments). By default, each root-level Inport and Outport block appears in the generated code as a
separate argument instead of a field of the standard I/O structures.

• To reduce the number of arguments, see “Reduce Number of Arguments by Using Structures”.
• To control the data types of the arguments, see “Control Data Types of Arguments”.

Prevent Unintended Changes to the Interface
Some changes that you make to a model change the entry-point function interfaces in the generated
code. For example, if you change the name of the model, the names of the functions can change. If
you configure the model code to exchange data through arguments, when you add or remove Inport
or Outport blocks or change the names of the blocks, the corresponding arguments can change.

For easier maintenance of your calling code, prevent changes to the interfaces of the entry-point
functions.

• If you exchange input and output data through arguments, configure the generated code to
package Inport and Outport blocks into structures instead of allowing each block to appear as a
separate argument (the default). Then, when you add or remove Inport or Outport blocks, or
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change their properties such as name and data type, the fields of the structures change, but the
function interfaces do not change. See “Reduce Number of Arguments by Using Structures” on
page 34-47.

• Set the data types of Inport and Outport blocks explicitly instead of using an inherited data type
setting (which these blocks use by default). Inherited data type settings can cause the blocks to
use different data types depending on the data types of upstream and downstream signals. For
more information about configuring data types, see “Control Signal Data Types”.

• With Embedded Coder, specify function names that do not depend on the model name. If you
specify a naming rule with a function customization template, do not use the token $R in the rule.
See “Control Names of Generated Entry-Point Functions (Embedded Coder)”.

Reduce Number of Arguments by Using Structures
Reducing the number of arguments of a function can improve the readability of the code and reduce
consumption of stack memory. To create a structure argument that can pass multiple pieces of data at
one time, use these techniques:

• Manually combine multiple Inport or Outport blocks so that they appear in the generated code as
fields of a structure or substructure of a standard data structure. The generated entry-point
function or functions accept the address of the structure as a separate argument or as a
substructure (field) of the standard I/O structures.

Replace the Inport or Outport blocks with a single block, and configure the new block as a
nonvirtual bus by using a Simulink.Bus object as the data type of the block. If your external
code defines the structure type, consider using the Simulink.importExternalCTypes function
to generate the bus object. See “Organize Data into Structures in Generated Code” on page 34-
145 and Simulink.importExternalCTypes.

• When you generate reentrant code with Embedded Coder, configure Inport and Outport blocks to
appear in aggregated structures by default. Set model configuration parameter Pass root-level
I/O as to a setting other than Individual arguments.

• To package Inport and Outport blocks into the real-time model data structure, select Part of
model data structure. The code generator aggregates the blocks into the default I/O
structures to which the real-time model data structure points. The generated entry-point
function or functions accept the real-time model data structure as a single argument. If you
choose this setting, the function has the smallest number of arguments.

• To aggregate Inport blocks into a structure and Outport blocks into a different structure, select
Structure reference. The generated entry-point function or functions accept the address
of each structure as an argument. Another argument accepts the real-time model data
structure. If you choose this setting, the inputs and outputs are more identifiable in the
function interfaces.

With this setting, if you remove the root-level Inport blocks or the root-level Outport blocks, the
function signature can change. Similarly, the signature can change if you add a root-level
Inport or Outport block to a model that does not include such blocks.

• For more control over the characteristics of the structures, set Pass root-level I/O as to Part
of model data structure. Then, set the default storage class for Inport and Outport
blocks to a structured storage class that you create. With this technique:

• You can create a single structure for the blocks or create two separate structures.
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• You can control the names of the structure types.
• The structures appear as substructures of the real-time model data structure. You must set

Pass root-level I/O as to Part of model data structure.

Create the storage class by using the Embedded Coder Dictionary (see “Define Storage
Classes, Memory Sections, and Function Templates for Software Architecture” on page 31-2).
Apply the storage class by using the Code Mappings editor (see “Configure Default Code
Generation for Data” on page 33-16).

For more information, see “Pass root-level I/O as”.

Control Data Types of Arguments
You can configure the generated entry-point functions to exchange data through arguments. For a
scalar or array argument, to control the name of the primitive data type, use a
Simulink.AliasType object to either set the data type of the corresponding block or to configure
data type replacements for the entire model. These techniques require Embedded Coder. For more
information, see “Control Data Type Names in Generated Code” on page 36-2.

Promote Data Item to the Interface
By default, the code generator assumes that Inport and Outport blocks at the root level of the model
constitute the data interface of the model. You can promote an arbitrary signal, block parameter, or
block state to the interface so that other systems and components can access it. See “Promote
Internal Data to the Interface” on page 34-65.

See Also

Related Examples
• “Design Data Interface by Configuring Inport and Outport Blocks” on page 34-167
• “Define Interfaces of Model Components”
• “Analyze the Generated Code Interface” on page 52-13
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “How Generated Code Exchanges Data with an Environment” on page 34-35
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Configure Generated Code According to Interface Control Document Specifications” on page

38-55
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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How Generated Code Stores Internal Signal, State, and
Parameter Data

To calculate outputs from inputs, the generated code stores some internal data in global memory. A
signal that does not connect to a root-level input or output (Inport or Outport block) is internal data.

Internal data can also include:

• A block state such as the state of a Unit Delay block. The algorithm must retain the state value
between execution cycles, so the generated code typically stores states in global memory (for
example, as a global variable or a field of a global structure variable).

• A block parameter, such as the Gain parameter of a Gain block, whose value the code generator
cannot inline in the code. For example, the code generator cannot inline the value of a nonscalar
parameter.

• The status indicator of a conditionally executed subsystem such as an enabled subsystem.

For more efficient code, you can configure optimizations such as Configuration Parameters >
Default parameter behavior and Configuration Parameters > Signal storage reuse that
attempt to eliminate storage for internal data. However, the optimizations cannot eliminate storage
for some data, which consume memory in the generated code.

When you understand the default format in which the generated code stores internal data, you can:

• Make signals accessible and parameters tunable by default. You can then interact with and
monitor the code during execution.

• Generate efficient production code by eliminating storage for internal data and, depending on
your hardware and build toolchain, controlling the placement in memory of data that the
optimizations cannot eliminate.

• Promote pieces of internal data to the model interface so that other components and systems can
access that data.

For information about how the generated code exchanges data with a calling environment through
interfaces, see “How Generated Code Exchanges Data with an Environment” on page 34-35.

Internal Data in the Generated Code
This example shows how the generated code stores internal data such as block states.

Explore Example Model

Open the example model rtwdemo_roll.

open_system('rtwdemo_roll')
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The model contains internal signals that do not connect to root-level Inport or Outport blocks. Some
of the signals have a name, such as the phiCmd signal.

The model also contains some blocks that maintain state data. For example, in the BasicRollMode
subsystem, a Discrete-Time Integrator block labeled Integrator maintains a state.

In the model, set Configuration Parameters > Code Generation > System target file to
grt.tlc.

set_param('rtwdemo_roll','SystemTargetFile','grt.tlc')

Inspect the setting for Configuration Parameters > Code Generation > Interface > Code
interface packaging. The setting Nonreusable function means that the generated code is not
reusable (reentrant).

For this example, generate simpler code by clearing Configuration Parameters > Code
Generation > Interface > Advanced parameters > Mat-file logging.

set_param('rtwdemo_roll','MatFileLogging','off')

Generate Nonreusable Code

Set these configuration parameters:

• Set Default parameter behavior to Tunable.
• Clear Signal storage reuse.

set_param('rtwdemo_roll','DefaultParameterBehavior','Tunable',...
    'OptimizeBlockIOStorage','off')

Generate code from the model.
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slbuild('rtwdemo_roll')

### Starting build procedure for: rtwdemo_roll
### Successful completion of build procedure for: rtwdemo_roll

Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                                    
=============================================================================================
rtwdemo_roll  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.748s

The file rtwdemo_roll.h defines several structure types that represent internal data. For example,
the block input and output structure defines one field for each internal signal in the model. Each field
name derives from the name of the block that generates the signal or, if you specify a name for the
signal, from the name of the signal.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,...
    '/* Block signals (default storage) */','} B_rtwdemo_roll_T;',1,1)

/* Block signals (default storage) */
typedef struct {
  real32_T phiCmd;                     /* '<Root>/ModeSwitch' */
  real32_T hdgError;                   /* '<S2>/Sum' */
  real32_T DispGain;                   /* '<S2>/DispGain' */
  real32_T Product;                    /* '<S2>/Product' */
  real32_T Abs;                        /* '<S3>/Abs' */
  real32_T FixPtUnitDelay1;            /* '<S4>/FixPt Unit Delay1' */
  real32_T Xnew;                       /* '<S4>/Enable' */
  real32_T TKSwitch;                   /* '<S3>/TKSwitch' */
  real32_T RefSwitch;                  /* '<S3>/RefSwitch' */
  real32_T Integrator;                 /* '<S1>/Integrator' */
  real32_T DispLimit;                  /* '<S1>/DispLimit' */
  real32_T Sum;                        /* '<S1>/Sum' */
  real32_T DispGain_f;                 /* '<S1>/DispGain' */
  real32_T RateLimit;                  /* '<S1>/RateLimit' */
  real32_T Sum1;                       /* '<S1>/Sum1' */
  real32_T RateGain;                   /* '<S1>/RateGain' */
  real32_T Sum2;                       /* '<S1>/Sum2' */
  real32_T CmdLimit;                   /* '<S1>/CmdLimit' */
  real32_T IntGain;                    /* '<S1>/IntGain' */
  boolean_T NotEngaged;                /* '<S3>/NotEngaged' */
  boolean_T TKThreshold;               /* '<S3>/TKThreshold' */
  boolean_T RefThreshold2;             /* '<S3>/RefThreshold2' */
  boolean_T RefThreshold1;             /* '<S3>/RefThreshold1' */
  boolean_T Or;                        /* '<S3>/Or' */
  boolean_T NotEngaged_e;              /* '<S1>/NotEngaged' */
} B_rtwdemo_roll_T;

The file defines a structure type, the DWork structure, to represent block states such as the state of
the Discrete-Time Integrator block.
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rtwdemodbtype(file,...
    '/* Block states (default storage) for system','} DW_rtwdemo_roll_T;',1,1)

/* Block states (default storage) for system '<Root>' */
typedef struct {
  real32_T FixPtUnitDelay1_DSTATE;     /* '<S4>/FixPt Unit Delay1' */
  real32_T Integrator_DSTATE;          /* '<S1>/Integrator' */
  int8_T Integrator_PrevResetState;    /* '<S1>/Integrator' */
} DW_rtwdemo_roll_T;

The file defines a structure type to represent parameter data. Each tunable block parameter in the
model, such as the Gain parameter of a Gain block, appears as a field of this structure. If a block
parameter acquires its value from a MATLAB variable or a Simulink.Parameter object, the
variable or object appears as a field, not the block parameter.

The file also defines a structure type, the real-time model data structure, whose single field
represents a run-time indication of whether the generated code has encountered an error during
execution.

rtwdemodbtype(file,'/* Real-time Model Data Structure */',...
    '/* Block parameters (default storage) */',1,0)

/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
  const char_T *errorStatus;
};

For the structure type that represents the real-time model data structure, the file
rtwdemo_roll_types.h creates an alias that the generated code later uses to allocate memory for
the structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll_types.h');
rtwdemodbtype(file,'/* Forward declaration for rtModel */',...
    'RT_MODEL_rtwdemo_roll_T;',1,1)

/* Forward declaration for rtModel */
typedef struct tag_RTM_rtwdemo_roll_T RT_MODEL_rtwdemo_roll_T;

Using these structure types, the file rtwdemo_roll.c defines (allocates memory for) global
structure variables that store internal data for the generated algorithm. The file also defines variables
that represent the real-time model data structure and a pointer to the structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
    '= &rtwdemo_roll_M_;',1,1)

/* Block signals (default storage) */
B_rtwdemo_roll_T rtwdemo_roll_B;

/* Block states (default storage) */
DW_rtwdemo_roll_T rtwdemo_roll_DW;

/* External inputs (root inport signals with default storage) */
ExtU_rtwdemo_roll_T rtwdemo_roll_U;
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/* External outputs (root outports fed by signals with default storage) */
ExtY_rtwdemo_roll_T rtwdemo_roll_Y;

/* Real-time model */
static RT_MODEL_rtwdemo_roll_T rtwdemo_roll_M_;
RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M = &rtwdemo_roll_M_;

The model step function, which represents the primary model algorithm, uses a void void
interface (with no arguments).

rtwdemodbtype(file,...
    '/* Model step function */','void rtwdemo_roll_step(void)',1,1)

/* Model step function */
void rtwdemo_roll_step(void)

In the function definition, the algorithm performs calculations and stores intermediate results in the
signal and state structures by directly accessing the global variables. The algorithm also reads
parameter data from the corresponding global variable. For example, in the BasicRollMode
subsystem, the code generated for the Integrator block reads and writes signal, state, and
parameter data from the structures.

rtwdemodbtype(file,'/* DiscreteIntegrator: ''<S1>/Integrator'' *',...
    '/* End of DiscreteIntegrator: ''<S1>/Integrator'' */',1,1)

  /* DiscreteIntegrator: '<S1>/Integrator' */
  if (rtwdemo_roll_B.NotEngaged_e || (rtwdemo_roll_DW.Integrator_PrevResetState
       != 0)) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
  }

  if (rtwdemo_roll_DW.Integrator_DSTATE >= rtwdemo_roll_P.intLim) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.intLim;
  } else if (rtwdemo_roll_DW.Integrator_DSTATE <=
             rtwdemo_roll_P.Integrator_LowerSat) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_LowerSat;
  }

  /* DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_B.Integrator = rtwdemo_roll_DW.Integrator_DSTATE;

  /* Saturate: '<S1>/DispLimit' */
  u0 = rtwdemo_roll_B.phiCmd;
  u1 = rtwdemo_roll_P.DispLimit_LowerSat;
  u2 = rtwdemo_roll_P.dispLim;
  if (u0 > u2) {
    /* Saturate: '<S1>/DispLimit' */
    rtwdemo_roll_B.DispLimit = u2;
  } else if (u0 < u1) {
    /* Saturate: '<S1>/DispLimit' */
    rtwdemo_roll_B.DispLimit = u1;
  } else {
    /* Saturate: '<S1>/DispLimit' */
    rtwdemo_roll_B.DispLimit = u0;
  }
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  /* End of Saturate: '<S1>/DispLimit' */

  /* Sum: '<S1>/Sum' incorporates:
   *  Inport: '<Root>/Phi'
   */
  rtwdemo_roll_B.Sum = rtwdemo_roll_B.DispLimit - rtwdemo_roll_U.Phi;

  /* Gain: '<S1>/DispGain' */
  rtwdemo_roll_B.DispGain_f = rtwdemo_roll_P.dispGain * rtwdemo_roll_B.Sum;

  /* Saturate: '<S1>/RateLimit' */
  u0 = rtwdemo_roll_B.DispGain_f;
  u1 = rtwdemo_roll_P.RateLimit_LowerSat;
  u2 = rtwdemo_roll_P.rateLim;
  if (u0 > u2) {
    /* Saturate: '<S1>/RateLimit' */
    rtwdemo_roll_B.RateLimit = u2;
  } else if (u0 < u1) {
    /* Saturate: '<S1>/RateLimit' */
    rtwdemo_roll_B.RateLimit = u1;
  } else {
    /* Saturate: '<S1>/RateLimit' */
    rtwdemo_roll_B.RateLimit = u0;
  }

  /* End of Saturate: '<S1>/RateLimit' */

  /* Sum: '<S1>/Sum1' incorporates:
   *  Inport: '<Root>/Rate_FB'
   */
  rtwdemo_roll_B.Sum1 = rtwdemo_roll_B.RateLimit - rtwdemo_roll_U.Rate_FB;

  /* Gain: '<S1>/RateGain' */
  rtwdemo_roll_B.RateGain = rtwdemo_roll_P.rateGain * rtwdemo_roll_B.Sum1;

  /* Sum: '<S1>/Sum2' */
  rtwdemo_roll_B.Sum2 = rtwdemo_roll_B.Integrator + rtwdemo_roll_B.RateGain;

  /* Saturate: '<S1>/CmdLimit' */
  u0 = rtwdemo_roll_B.Sum2;
  u1 = rtwdemo_roll_P.CmdLimit_LowerSat;
  u2 = rtwdemo_roll_P.cmdLim;
  if (u0 > u2) {
    /* Saturate: '<S1>/CmdLimit' */
    rtwdemo_roll_B.CmdLimit = u2;
  } else if (u0 < u1) {
    /* Saturate: '<S1>/CmdLimit' */
    rtwdemo_roll_B.CmdLimit = u1;
  } else {
    /* Saturate: '<S1>/CmdLimit' */
    rtwdemo_roll_B.CmdLimit = u0;
  }

  /* End of Saturate: '<S1>/CmdLimit' */

  /* Gain: '<S1>/IntGain' */
  rtwdemo_roll_B.IntGain = rtwdemo_roll_P.intGain * rtwdemo_roll_B.Sum1;
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  /* Update for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_DW.Integrator_DSTATE += rtwdemo_roll_P.Integrator_gainval *
    rtwdemo_roll_B.IntGain;
  if (rtwdemo_roll_DW.Integrator_DSTATE >= rtwdemo_roll_P.intLim) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.intLim;
  } else if (rtwdemo_roll_DW.Integrator_DSTATE <=
             rtwdemo_roll_P.Integrator_LowerSat) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_LowerSat;
  }

  rtwdemo_roll_DW.Integrator_PrevResetState = (int8_T)
    rtwdemo_roll_B.NotEngaged_e;

  /* End of Update for DiscreteIntegrator: '<S1>/Integrator' */
  /* End of Outputs for SubSystem: '<Root>/BasicRollMode' */

  /* Switch: '<Root>/EngSwitch' incorporates:
   *  Inport: '<Root>/AP_Eng'
   */
  if (rtwdemo_roll_U.AP_Eng) {
    /* Outport: '<Root>/Ail_Cmd' */
    rtwdemo_roll_Y.Ail_Cmd = rtwdemo_roll_B.CmdLimit;
  } else {
    /* Outport: '<Root>/Ail_Cmd' incorporates:
     *  Constant: '<Root>/Zero'
     */
    rtwdemo_roll_Y.Ail_Cmd = rtwdemo_roll_P.Zero_Value_c;
  }

  /* End of Switch: '<Root>/EngSwitch' */
}

/* Model initialize function */
void rtwdemo_roll_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_roll_M, (NULL));

  /* block I/O */
  (void) memset(((void *) &rtwdemo_roll_B), 0,
                sizeof(B_rtwdemo_roll_T));

  /* states (dwork) */
  (void) memset((void *)&rtwdemo_roll_DW, 0,
                sizeof(DW_rtwdemo_roll_T));

  /* external inputs */
  (void)memset(&rtwdemo_roll_U, 0, sizeof(ExtU_rtwdemo_roll_T));

  /* external outputs */
  rtwdemo_roll_Y.Ail_Cmd = 0.0F;

  /* SystemInitialize for Atomic SubSystem: '<Root>/RollAngleReference' */
  /* InitializeConditions for UnitDelay: '<S4>/FixPt Unit Delay1' */
  rtwdemo_roll_DW.FixPtUnitDelay1_DSTATE = rtwdemo_roll_P.LatchPhi_vinit;
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  /* End of SystemInitialize for SubSystem: '<Root>/RollAngleReference' */

  /* SystemInitialize for Atomic SubSystem: '<Root>/BasicRollMode' */
  /* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
  rtwdemo_roll_DW.Integrator_PrevResetState = 0;

  /* End of SystemInitialize for SubSystem: '<Root>/BasicRollMode' */
}

/* Model terminate function */
void rtwdemo_roll_terminate(void)
{
  /* (no terminate code required) */
}

Due to the void void interface and the direct data access, the function is not reentrant. If you call
the function multiple times in an application, each call writes data to the global structure variables
and the subsequent call can read that data, resulting in unintentional interference between the calls.

The model initialization function rtwdemo_roll_initialize initializes all of the internal data to
zero. The function also initializes the error status by calling a specialized macro function. The
initialization function directly accesses the global variables, which means that the function is not
reentrant.

rtwdemodbtype(file,'/* Model initialize function */',...
    'sizeof(DW_rtwdemo_roll_T));',1,1)

/* Model initialize function */
void rtwdemo_roll_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_roll_M, (NULL));

  /* block I/O */
  (void) memset(((void *) &rtwdemo_roll_B), 0,
                sizeof(B_rtwdemo_roll_T));

  /* states (dwork) */
  (void) memset((void *)&rtwdemo_roll_DW, 0,
                sizeof(DW_rtwdemo_roll_T));

The function then initializes the block states in the DWork structure to the initial values that the block
parameters in the model specify. Two of the three states in the model have tunable initial values, so
the code initializes them by reading data from the parameters structure.

rtwdemodbtype(file,...
    '/* SystemInitialize for Atomic SubSystem: ''<Root>/RollAngleReference'' */',...
    '/* Model terminate function */',1,0)

  /* SystemInitialize for Atomic SubSystem: '<Root>/RollAngleReference' */
  /* InitializeConditions for UnitDelay: '<S4>/FixPt Unit Delay1' */
  rtwdemo_roll_DW.FixPtUnitDelay1_DSTATE = rtwdemo_roll_P.LatchPhi_vinit;
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  /* End of SystemInitialize for SubSystem: '<Root>/RollAngleReference' */

  /* SystemInitialize for Atomic SubSystem: '<Root>/BasicRollMode' */
  /* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
  rtwdemo_roll_DW.Integrator_PrevResetState = 0;

  /* End of SystemInitialize for SubSystem: '<Root>/BasicRollMode' */
}

Generate Reusable Code

You can configure the generated code as reentrant, which means you can call the entry-point
functions multiple times in an application. With this configuration, instead of directly accessing global
variables, the entry-point functions accept internal data through formal parameters (pointer
arguments). With these pointer arguments, each call can maintain internal data in a set of separate
global variables, preventing unintentional interaction between the calls.

In the model, set Configuration Parameters > Code Generation > Interface > Code interface
packaging to Reusable function.

set_param('rtwdemo_roll','CodeInterfacePackaging','Reusable function')

Generate code from the model.

slbuild('rtwdemo_roll')

### Starting build procedure for: rtwdemo_roll
### Successful completion of build procedure for: rtwdemo_roll

Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                   
============================================================================
rtwdemo_roll  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 9.203s

Now, in rtwdemo_roll.h, the real-time model data structure contains pointers to the error
indication, the internal data, and primary input and output data in the form of ExtU and ExtY
substructures (the fields of which represent Inport and Outport blocks at the root level of the model).

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,'/* Real-time Model Data Structure */',...
    '/* External data declarations for dependent source files */',1,0)

/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
  const char_T *errorStatus;
  B_rtwdemo_roll_T *blockIO;
  ExtU_rtwdemo_roll_T *inputs;
  ExtY_rtwdemo_roll_T *outputs;
  DW_rtwdemo_roll_T *dwork;
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};

/* Block parameters (default storage) */
extern P_rtwdemo_roll_T rtwdemo_roll_P;

To call the generated code multiple times in an application, your code must allocate memory for a
real-time model data structure per call. The file rtwdemo_roll.c defines a specialized function that
allocates memory for a new real-time model data structure and returns a pointer to the structure. The
function also allocates memory for the substructures that the fields in the model data structure point
to, such as the DWork structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Model data allocation function */',...
    'RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)',1,1)

/* Model data allocation function */
RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)

The model step function accepts an argument that represents the real-time model data structure.

rtwdemodbtype(file,'/* Model step function */','void rtwdemo_roll_step',1,1)

/* Model step function */
void rtwdemo_roll_step(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

In the function definition, the algorithm first extracts each pointer from the real-time model data
structure into a local variable.

rtwdemodbtype(file,'*rtwdemo_roll_B =','rtwdemo_roll_M->outputs;',1,1)

  B_rtwdemo_roll_T *rtwdemo_roll_B = rtwdemo_roll_M->blockIO;
  DW_rtwdemo_roll_T *rtwdemo_roll_DW = rtwdemo_roll_M->dwork;
  ExtU_rtwdemo_roll_T *rtwdemo_roll_U = (ExtU_rtwdemo_roll_T *)
    rtwdemo_roll_M->inputs;
  ExtY_rtwdemo_roll_T *rtwdemo_roll_Y = (ExtY_rtwdemo_roll_T *)
    rtwdemo_roll_M->outputs;

Then, to access the internal data stored in global memory, the algorithm interacts with these local
variables.

rtwdemodbtype(file,'/* DiscreteIntegrator: ''<S1>/Integrator'' */',...
    '/* End of DiscreteIntegrator: ''<S1>/Integrator'' */',1,1)

  /* DiscreteIntegrator: '<S1>/Integrator' */
  if (rtwdemo_roll_B->NotEngaged_e ||
      (rtwdemo_roll_DW->Integrator_PrevResetState != 0)) {
    rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
  }

  if (rtwdemo_roll_DW->Integrator_DSTATE >= rtwdemo_roll_P.intLim) {
    rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P.intLim;
  } else if (rtwdemo_roll_DW->Integrator_DSTATE <=
             rtwdemo_roll_P.Integrator_LowerSat) {
    rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P.Integrator_LowerSat;
  }
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  /* DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_B->Integrator = rtwdemo_roll_DW->Integrator_DSTATE;

  /* Saturate: '<S1>/DispLimit' */
  u0 = rtwdemo_roll_B->phiCmd;
  u1 = rtwdemo_roll_P.DispLimit_LowerSat;
  u2 = rtwdemo_roll_P.dispLim;
  if (u0 > u2) {
    /* Saturate: '<S1>/DispLimit' */
    rtwdemo_roll_B->DispLimit = u2;
  } else if (u0 < u1) {
    /* Saturate: '<S1>/DispLimit' */
    rtwdemo_roll_B->DispLimit = u1;
  } else {
    /* Saturate: '<S1>/DispLimit' */
    rtwdemo_roll_B->DispLimit = u0;
  }

  /* End of Saturate: '<S1>/DispLimit' */

  /* Sum: '<S1>/Sum' incorporates:
   *  Inport: '<Root>/Phi'
   */
  rtwdemo_roll_B->Sum = rtwdemo_roll_B->DispLimit - rtwdemo_roll_U->Phi;

  /* Gain: '<S1>/DispGain' */
  rtwdemo_roll_B->DispGain_f = rtwdemo_roll_P.dispGain * rtwdemo_roll_B->Sum;

  /* Saturate: '<S1>/RateLimit' */
  u0 = rtwdemo_roll_B->DispGain_f;
  u1 = rtwdemo_roll_P.RateLimit_LowerSat;
  u2 = rtwdemo_roll_P.rateLim;
  if (u0 > u2) {
    /* Saturate: '<S1>/RateLimit' */
    rtwdemo_roll_B->RateLimit = u2;
  } else if (u0 < u1) {
    /* Saturate: '<S1>/RateLimit' */
    rtwdemo_roll_B->RateLimit = u1;
  } else {
    /* Saturate: '<S1>/RateLimit' */
    rtwdemo_roll_B->RateLimit = u0;
  }

  /* End of Saturate: '<S1>/RateLimit' */

  /* Sum: '<S1>/Sum1' incorporates:
   *  Inport: '<Root>/Rate_FB'
   */
  rtwdemo_roll_B->Sum1 = rtwdemo_roll_B->RateLimit - rtwdemo_roll_U->Rate_FB;

  /* Gain: '<S1>/RateGain' */
  rtwdemo_roll_B->RateGain = rtwdemo_roll_P.rateGain * rtwdemo_roll_B->Sum1;

  /* Sum: '<S1>/Sum2' */
  rtwdemo_roll_B->Sum2 = rtwdemo_roll_B->Integrator + rtwdemo_roll_B->RateGain;

  /* Saturate: '<S1>/CmdLimit' */
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  u0 = rtwdemo_roll_B->Sum2;
  u1 = rtwdemo_roll_P.CmdLimit_LowerSat;
  u2 = rtwdemo_roll_P.cmdLim;
  if (u0 > u2) {
    /* Saturate: '<S1>/CmdLimit' */
    rtwdemo_roll_B->CmdLimit = u2;
  } else if (u0 < u1) {
    /* Saturate: '<S1>/CmdLimit' */
    rtwdemo_roll_B->CmdLimit = u1;
  } else {
    /* Saturate: '<S1>/CmdLimit' */
    rtwdemo_roll_B->CmdLimit = u0;
  }

  /* End of Saturate: '<S1>/CmdLimit' */

  /* Gain: '<S1>/IntGain' */
  rtwdemo_roll_B->IntGain = rtwdemo_roll_P.intGain * rtwdemo_roll_B->Sum1;

  /* Update for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_DW->Integrator_DSTATE += rtwdemo_roll_P.Integrator_gainval *
    rtwdemo_roll_B->IntGain;
  if (rtwdemo_roll_DW->Integrator_DSTATE >= rtwdemo_roll_P.intLim) {
    rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P.intLim;
  } else if (rtwdemo_roll_DW->Integrator_DSTATE <=
             rtwdemo_roll_P.Integrator_LowerSat) {
    rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P.Integrator_LowerSat;
  }

  rtwdemo_roll_DW->Integrator_PrevResetState = (int8_T)
    rtwdemo_roll_B->NotEngaged_e;

  /* End of Update for DiscreteIntegrator: '<S1>/Integrator' */
  /* End of Outputs for SubSystem: '<Root>/BasicRollMode' */

  /* Switch: '<Root>/EngSwitch' incorporates:
   *  Inport: '<Root>/AP_Eng'
   */
  if (rtwdemo_roll_U->AP_Eng) {
    /* Outport: '<Root>/Ail_Cmd' */
    rtwdemo_roll_Y->Ail_Cmd = rtwdemo_roll_B->CmdLimit;
  } else {
    /* Outport: '<Root>/Ail_Cmd' incorporates:
     *  Constant: '<Root>/Zero'
     */
    rtwdemo_roll_Y->Ail_Cmd = rtwdemo_roll_P.Zero_Value_c;
  }

  /* End of Switch: '<Root>/EngSwitch' */
}

/* Model initialize function */
void rtwdemo_roll_initialize(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)
{
  DW_rtwdemo_roll_T *rtwdemo_roll_DW = rtwdemo_roll_M->dwork;

  /* SystemInitialize for Atomic SubSystem: '<Root>/RollAngleReference' */
  /* InitializeConditions for UnitDelay: '<S4>/FixPt Unit Delay1' */
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  rtwdemo_roll_DW->FixPtUnitDelay1_DSTATE = rtwdemo_roll_P.LatchPhi_vinit;

  /* End of SystemInitialize for SubSystem: '<Root>/RollAngleReference' */

  /* SystemInitialize for Atomic SubSystem: '<Root>/BasicRollMode' */
  /* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
  rtwdemo_roll_DW->Integrator_PrevResetState = 0;

  /* End of SystemInitialize for SubSystem: '<Root>/BasicRollMode' */
}

/* Model terminate function */
void rtwdemo_roll_terminate(RT_MODEL_rtwdemo_roll_T * rtwdemo_roll_M)
{
  /* model code */
  rt_FREE(rtwdemo_roll_M->blockIO);
  rt_FREE(rtwdemo_roll_M->inputs);
  rt_FREE(rtwdemo_roll_M->outputs);
  rt_FREE(rtwdemo_roll_M->dwork);
  rt_FREE(rtwdemo_roll_M);
}

/* Model data allocation function */
RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)
{
  RT_MODEL_rtwdemo_roll_T *rtwdemo_roll_M;
  rtwdemo_roll_M = (RT_MODEL_rtwdemo_roll_T *) malloc(sizeof
    (RT_MODEL_rtwdemo_roll_T));
  if (rtwdemo_roll_M == NULL) {
    return NULL;
  }

  (void) memset((char *)rtwdemo_roll_M, 0,
                sizeof(RT_MODEL_rtwdemo_roll_T));

  /* block I/O */
  {
    B_rtwdemo_roll_T *b = (B_rtwdemo_roll_T *) malloc(sizeof(B_rtwdemo_roll_T));
    rt_VALIDATE_MEMORY(rtwdemo_roll_M,b);
    rtwdemo_roll_M->blockIO = (b);
  }

  /* states (dwork) */
  {
    DW_rtwdemo_roll_T *dwork = (DW_rtwdemo_roll_T *) malloc(sizeof
      (DW_rtwdemo_roll_T));
    rt_VALIDATE_MEMORY(rtwdemo_roll_M,dwork);
    rtwdemo_roll_M->dwork = (dwork);
  }

  /* external inputs */
  {
    ExtU_rtwdemo_roll_T *rtwdemo_roll_U = (ExtU_rtwdemo_roll_T *) malloc(sizeof
      (ExtU_rtwdemo_roll_T));
    rt_VALIDATE_MEMORY(rtwdemo_roll_M,rtwdemo_roll_U);
    rtwdemo_roll_M->inputs = (((ExtU_rtwdemo_roll_T *) rtwdemo_roll_U));
  }
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  /* external outputs */
  {
    ExtY_rtwdemo_roll_T *rtwdemo_roll_Y = (ExtY_rtwdemo_roll_T *) malloc(sizeof
      (ExtY_rtwdemo_roll_T));
    rt_VALIDATE_MEMORY(rtwdemo_roll_M,rtwdemo_roll_Y);
    rtwdemo_roll_M->outputs = (rtwdemo_roll_Y);
  }

  {
    B_rtwdemo_roll_T *rtwdemo_roll_B = rtwdemo_roll_M->blockIO;
    DW_rtwdemo_roll_T *rtwdemo_roll_DW = rtwdemo_roll_M->dwork;
    ExtU_rtwdemo_roll_T *rtwdemo_roll_U = (ExtU_rtwdemo_roll_T *)
      rtwdemo_roll_M->inputs;
    ExtY_rtwdemo_roll_T *rtwdemo_roll_Y = (ExtY_rtwdemo_roll_T *)
      rtwdemo_roll_M->outputs;

    /* block I/O */
    (void) memset(((void *) rtwdemo_roll_B), 0,
                  sizeof(B_rtwdemo_roll_T));

    /* states (dwork) */
    (void) memset((void *)rtwdemo_roll_DW, 0,
                  sizeof(DW_rtwdemo_roll_T));

    /* external inputs */
    (void)memset(rtwdemo_roll_U, 0, sizeof(ExtU_rtwdemo_roll_T));

    /* external outputs */
    rtwdemo_roll_Y->Ail_Cmd = 0.0F;
  }

  return rtwdemo_roll_M;
}

Similarly, the model initialization function accepts the real-time model data structure as an argument.

rtwdemodbtype(file,...
    '/* Model initialize function */','void rtwdemo_roll_initialize',1,1)

/* Model initialize function */
void rtwdemo_roll_initialize(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

Because each call that you make to an entry-point function interacts with a separate real-time model
data structure, you avoid unintentional interaction between the calls.

Eliminate Internal Data with Code Generation Optimizations

For more efficient code that consumes less memory, select the optimizations, such as Default
parameter behavior, that you cleared earlier.

set_param('rtwdemo_roll','DefaultParameterBehavior','Inlined',...
    'OptimizeBlockIOStorage','on',...
    'LocalBlockOutputs','on')

In this example, for simpler code, set Code interface packaging to Nonreusable function.

set_param('rtwdemo_roll','CodeInterfacePackaging','Nonreusable function')
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Generate code from the model.

slbuild('rtwdemo_roll')

### Starting build procedure for: rtwdemo_roll
### Successful completion of build procedure for: rtwdemo_roll

Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                   
============================================================================
rtwdemo_roll  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 8.078s

Now, rtwdemo_roll.h does not define a structure for block inputs and outputs. For all of the
internal signals in the model, the optimizations either eliminated storage or created local function
variables instead of global structure fields.

The optimizations were not able to eliminate storage for the three block states, so the file continues
to define the DWork structure type.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,...
    '/* Block states (default storage) for system','} DW_rtwdemo_roll_T;',1,1)

/* Block states (default storage) for system '<Root>' */
typedef struct {
  real32_T FixPtUnitDelay1_DSTATE;     /* '<S4>/FixPt Unit Delay1' */
  real32_T Integrator_DSTATE;          /* '<S1>/Integrator' */
  int8_T Integrator_PrevResetState;    /* '<S1>/Integrator' */
} DW_rtwdemo_roll_T;

The code generated for the Discrete-Time Integrator block now stores state and output data only in
the DWork structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Update for DiscreteIntegrator: ''<S1>/Integrator''',...
    '/* End of Update for DiscreteIntegrator: ''<S1>/Integrator'' */',1,1)

  /* Update for DiscreteIntegrator: '<S1>/Integrator' incorporates:
   *  Gain: '<S1>/IntGain'
   */
  rtwdemo_roll_DW.Integrator_DSTATE += 0.5F * rtb_TKSwitch * 0.025F;
  if (rtwdemo_roll_DW.Integrator_DSTATE >= 5.0F) {
    rtwdemo_roll_DW.Integrator_DSTATE = 5.0F;
  } else if (rtwdemo_roll_DW.Integrator_DSTATE <= -5.0F) {
    rtwdemo_roll_DW.Integrator_DSTATE = -5.0F;
  }

  rtwdemo_roll_DW.Integrator_PrevResetState = (int8_T)rtb_NotEngaged_f;
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The optimizations also eliminated storage for the block parameters in the model. For example, in the
Discrete-Time Integrator block, the Upper saturation limit and Lower saturation limit
parameters are set to intLim and -intLim. intLim is a Simulink.Parameter object that stores
the value 5. In the code generated for the Discrete-Time Integrator, these block parameters and
intLim appear as inlined literal numbers 5.0F and -5.0F.

If a model contains a parameter that the code generator cannot inline directly (for example, an array
parameter), the code defines a structure type that represents the data. This constant parameters
structure uses the const storage type qualifier, so some build toolchains can optimize the assembly
code further.

Local Variables in the Generated Code
When you select the optimization Configuration Parameters > Enable local block outputs, the
code generator attempts to yield more efficient code by representing internal signals as local
variables instead of fields of a global structure. If the memory consumed by local variables risks
exceeding the stack space available on your target hardware, consider indicating the maximum stack
size by setting Configuration Parameters > Maximum stack size (bytes). For more information,
see “Maximum stack size (bytes)”.

Appearance of Test Points in the Generated Code
A test point is a signal that is stored in a unique memory location. For information about including
test points in your model, see “Configure Signals as Test Points”.

When you generate code for models that include test points, the build process allocates a separate
memory buffer for each test point. By default, test points are stored as members of a standard data
structure such as model_B.

If you have Embedded Coder:

• You can control the default representation of test points by specifying code generation settings for
the Internal data category of data in the Code Mapping Editor (see “Configure Default Code
Generation for Data” on page 33-16).

• You can specify that the build process ignore test points in the model, allowing optimal buffer
allocation, by using the “Ignore test point signals” parameter. Ignoring test points facilitates
transitioning from prototyping to deployment and avoids accidental degradation of generated code
due to workflow artifacts. See “Ignore test point signals”.

Virtual buses do not appear in generated code, even when associated with a test point. To display a
bus in generated code, use a nonvirtual bus or a virtual bus converted to a nonvirtual bus by a Signal
Conversion block.

Appearance of Workspace Variables in the Generated Code
Workspace variables are variables that you use to specify block parameter values in a model.
Workspace variables include numeric MATLAB variables and Simulink.Parameter objects that you
store in a workspace, such as the base workspace, or in a data dictionary.

When you set Default parameter behavior to Tunable, by default, workspace variables appear in
the generated code as tunable fields of the global parameters structure. If you use such a variable to
specify multiple block parameter values, the variable appears as a single field of the global
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parameters structure. The code does not create multiple fields to represent the block parameters.
Therefore, tuning the field value during code execution changes the mathematical behavior of the
model in the same way as tuning the value of the MATLAB variable or parameter object during
simulation.

If you have Embedded Coder, you can control the default representation of workspace variables by
specifying code generation settings for categories of parameter data in the Code Mapping Editor (see
“Configure Default Code Generation for Data” on page 33-16).

• The Model parameters category applies to variables that you store in a model workspace.
• The External parameters category applies to variables that you store in the base workspace or a

data dictionary.

Promote Internal Data to the Interface
By default, the code generator assumes that other systems and components in your application do not
need to access internal data. For example, internal data are subject to optimizations that can
eliminate them from the generated code. For prototyping and testing purposes, you can access
internal data by clearing the optimizations or by configuring test points and applying storage classes
(see “Preserve Variables in Generated Code” on page 34-2). For optimized production code, configure
individual data items to appear in the generated code as part of the model interface.

Data That You Can Promote

Depending on the reentrancy of the generated code, that is, the setting that you choose for Code
interface packaging, you can configure each data item in a model to participate in the interface by
appearing in the code as one of these entities:

• A global symbol, such as a global variable or a call to a specialized function
• A formal parameter (argument) of the generated entry-point functions

The table shows the mechanisms that each category of data can use to participate in the interface.

Category of Data Appear as Global Symbol Appear as Argument of
Entry-Point Function

Root-level Inport or Outport
block

Only for a nonreentrant model. Yes.

Signal connecting two blocks Only for a nonreentrant model. Only for a reentrant model and
only as a field of a structure.

Alternatively, connect the signal
to a root-level Outport block.

Block state Only for a nonreentrant model. Only for a reentrant model and
only as a field of a structure.

Data store such as a Data Store
Memory block

Yes. Only for a reentrant model and
only as a field of a structure.

Block parameter or parameter
object such as
Simulink.Parameter

Yes. Only as a field of a structure.
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Single-Instance Algorithm

For a single-instance algorithm (you set Code interface packaging to Nonreusable function),
apply storage classes directly to individual data items by using the Model Data Editor or the Property
Inspector. With a directly applied storage class, a data item appears in the code as a global symbol
such as a global variable. The storage class also prevents optimizations from eliminating storage for
the data item.

You can apply storage classes to signals, block states, and block parameters. (For block parameters,
you apply storage classes indirectly through parameter objects such as Simulink.Parameter).
However, for a signal, consider connecting the signal to an Outport block at the root level of the
model. Then, optionally, you can apply a storage class to the block. In the block diagram, the Outport
block shows that the signal represents a system output.

For more information about storage classes, see “C Code Generation Configuration for Model
Interface Elements” on page 33-2.

Reentrant Algorithm

For a reentrant algorithm (you set Code interface packaging to Reusable function), use
different techniques to configure data items to appear in the code as formal parameters (arguments)
of the generated entry-point functions.

• For an internal signal, directly apply the storage class Model default (see “C Code Generation
Configuration for Model Interface Elements” on page 33-2). If you have Embedded Coder, in the
Code Mapping Editor, for the Internal data category, set the default storage class to Default or
to a structured storage class that you define in an Embedded Coder Dictionary (see “Create Code
Definitions for Use in the Code Mappings Editor” on page 31-2). Alternatively, configure the signal
as a test point (see “Appearance of Test Points in the Generated Code” on page 34-64). By default,
the signal appears as a field of one of the standard data structures (see “How Generated Code
Stores Internal Signal, State, and Parameter Data” on page 34-49). If you do not want the signal to
appear in production code, use a test point so that you can later select the model configuration
parameter Ignore test point signals.

Alternatively, connect the signal to an Outport block at the root level of the model. Connecting the
signal to a root-level Outport block prevents optimizations from eliminating the signal from the
code. To help with signal routing in a large model, use Goto and From blocks.

• For a block parameter, create a parameter object such as Simulink.Parameter and directly
apply a storage class other than Auto to the object. The storage class prevents optimizations from
inlining the parameter value in the code.

With the storage class, the parameter is shared between instances of the model, which are calls to
the entry-point functions. The functions access the parameter data directly, as a global symbol, not
an argument. You cannot configure a parameter to appear in the code as an argument, so you
cannot enable each instance of the model to use a different value for the parameter.

For information about applying storage classes, see “C Code Generation Configuration for Model
Interface Elements”.
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Control Default Representation of Internal Data (Embedded Coder)
By default, the code generator aggregates internal data that optimizations cannot eliminate, such as
most state data, into standard structures such as the DWork structure. With Embedded Coder, you
can control how the generated code stores this data.

Control Placement of Data in Memory by Inserting Pragmas

Use the Code Mapping Editor to specify a default memory section for each category of data such as
states and signals (Internal data). In the generated code, your custom pragmas or other decorations
surround the data definitions and declarations.

You can also partition the structures according to atomic subsystems in your model so that you can
specify different default memory sections for the data of subroutines and other algorithmic
subcomponents.

For more information, see “Control Data and Function Placement in Memory by Inserting Pragmas”
on page 43-2.

Control Names of Types, Fields, and Global Variables for Standard Data Structures

You can control some characteristics of the standard data structures. For more information, see
“Control Data Type Names in Generated Code” on page 36-2.

For additional control over structure characteristics, such as placement in generated code files,
create your own structured storage class by using the Embedded Coder Dictionary. Then, apply the
storage class to categories of data by using the Code Mapping Editor. The storage class removes the
data from the standard structures, creating other structures that you can more finely control. For
more information about applying default storage classes to categories of data, see “Configure Default
Code Generation for Data” on page 33-16. For more information about creating a storage class, see
“Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” on
page 31-2.

Organize Data into Structures According to Subcomponents

• In the standard data structures, to create substructures that contain the data for a single-instance
(nonreentrant) subroutine or subcomponent, use an atomic subsystem to encapsulate the
corresponding blocks. In the subsystem parameters, set Function packaging to Reusable
function. For more information, see “Generate Modular Function Code for Nonvirtual
Subsystems” on page 41-2.

Alternatively, encapsulate the blocks in a model and use a Model block. In the referenced model,
set Configuration Parameters > Model Referencing > Total number of instances allowed
per top model to Multiple. For more information, see “Generate Code for Model Reference
Hierarchy” on page 5-2.

• To create separate, standalone structures that contain the data for a multi-instance (reentrant)
subroutine or subcomponent, in the model, use an atomic subsystem to encapsulate the
corresponding blocks. In the subsystem parameters, set Function packaging to Nonreusable
function and select Function with separate data. For more information, see “Generate
Modular Function Code for Nonvirtual Subsystems” on page 41-2.

Alternatively, encapsulate the blocks in a model and use a Model block. In the referenced model,
choose one of these techniques:
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• Set Configuration Parameters > Model Referencing > Total number of instances
allowed per top model to One. For more information, see “Generate Code for Model
Reference Hierarchy” on page 5-2.

• Set Total number of instances allowed per top model to Multiple and create a
structured storage class by using an Embedded Coder Dictionary. Then, apply the storage class
to categories of data by using the Code Mapping Editor. To create a storage class, see “Define
Storage Classes, Memory Sections, and Function Templates for Software Architecture” on page
31-2. To apply the storage class to categories of data, see “Configure Default Code Generation
for Data” on page 33-16.

Organize Signal and Parameter Data into Meaningful, Custom Structures and Substructures

To organize arbitrary signals and parameters into custom structures and substructures, create
nonvirtual bus signals and parameter structures. Optionally, to prevent optimizations from
eliminating the data from the code, set the storage class of a bus signal or parameter structure to a
value other than Auto (the default setting).

As you add blocks to the model, you must explicitly place each new signal and parameter into a bus
or a structure.

For more information, see “Organize Data into Structures in Generated Code” on page 34-145.

Create Separate Global Variables Instead of Structure Fields

To make a category of internal data appear in the generated code as separate, unstructured global
variables instead of fields of a standard data structure, apply an unstructured storage class to the
data category by using the Code Mapping Editor. For example, apply the storage class
ExportedGlobal. However, if you generate multi-instance, reentrant code by setting the
configuration parameter Code interface packaging to a value other than Nonreusable
function, you cannot use this technique for some categories of data (see “Storage Classes and
Reentrant, Multi-Instance Models and Components”).

To apply default storage classes to categories of data by using the Code Mapping Editor, see
“Configure Default Code Generation for Data” on page 33-16. To choose a storage class, see “Choose
Storage Class for Controlling Data Representation in Generated Code”.

See Also

Related Examples
• “Data Structures in the Generated Code” on page 34-31
• “How Generated Code Exchanges Data with an Environment” on page 34-35
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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Choose Data Configuration Approach
When you generate code from a model, the code includes design data such as signals, states, and
parameters, which your application code can read from and write to. When deciding how you want
this data represented in the generated code, consider:

• What types of data elements do I want to use in my model?
• Where do I want to store the data?
• What are my code generation objectives?
• How can I configure the data to meet my code generation objectives?

The answers to these questions depend on your model architecture (standalone model, standalone
hierarchy of referenced models, or a system of components), your application type (reentrant or
single-instance), and whether you are integrating your code with existing external code.

Data Element Categories
The possible data elements in your model fall under the data element types listed in this table.

Data Element Type Description
Inports Root-level input ports of a model, such as Inport and Bus Element

In blocks.
Outports Root-level output ports of a model, such as Outport and Bus

Element Out blocks.
Model-scoped parameters • Model parameter arguments — Variables in the model

workspace that you configure as model arguments. These
parameters are exposed at the model block to enable the
parent model to provide different values for each model
instance.

• Model parameters — Parameters that are defined in the model
workspace. Unlike model arguments, these parameters are
shared by each instance of the model.

External parameters Parameters that you define as objects in the base workspace or in
a data dictionary. Multiple models in an application can use these
parameters.
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Data Element Type Description
Data stores • Internal data (local data stores) — Data stores that are

accessible from anywhere in a subsystem hierarchy that is at
or below the level at which you define the data store. Defined
graphically in a model by including a Data Store Memory block
or by creating a signal object in the model workspace.

• Global data stores — Data stores that are defined by a signal
object in the base workspace or in a data dictionary. Multiple
models in an application can use these data stores.

• Shared local data stores — Data Store Memory blocks that
have the block parameter Share across model instances set.
These data stores are accessible only in the system where the
Data Store Memory block is located. The data store value is
shared across instances of the model.

Internal data Local data, such as internal signals and block states. Includes
local data stores.

Constants Constant parameters and constant-value block output in a model.

The code configuration options available for your data are dependent on the category of data that you
are configuring. Where you store the data determines if you configure it by using a data object or by
using a code mapping that is saved with the model.

Where to Store Data Elements Used by Your Model
Where you store data for your model can depend on the type of model architecture that you are using
and your modeling goals:

• MATLAB base workspace — Used for the temporary storage of data while experimenting with
modeling techniques.

• Model workspace — Used to permanently store data that is local to a single model. Because the
data is stored with the model, using this workspace can improve model portability. The model
workspace is predominantly used to store parameters, arguments, and numeric variables. These
elements are not typically stored in the model workspace:

• Signal objects — You cannot configure a signal object in the model workspace for code
generation. You do not need to define a signal object to configure a signal for code generation.

• Data type objects.
• Simulink data dictionary — Used to permanently store global data, data types, and data that is

shared between models.

For more information, see “Determine Where to Store Variables and Objects for Simulink Models”.

When to Configure a Data Element for Code Generation
Whether you customize the generation of your data for code generation depends on your objectives
for the generated code. If you choose not to configure customizations, the code generator determines
whether to eliminate or change the representation of the data in generated code for optimization
purposes.
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There are many reasons you might choose to configure a data item. Configuring data prevents
optimizations that might eliminate the data item from the generated code and enables you to
configure how the generated code stores and defines the data item. For example, if you configure a
data item, you can:

• Tune parameters.
• Monitor signals and states during execution.
• Configure data placement in memory.
• Exchange data with external code.
• Improve readability and traceability of generated code.

Configure a Data Element for Code Generation
To configure your data for code generation, apply a storage class. A storage class is a code generation
setting that enables you to control the appearance and placement of a data element in the generated
code and prevents optimizations that might eliminate storage for that data element. You can use
storage classes available with Simulink Coder and Embedded Coder. If you have special requirements
that are not met by these storage classes and you are generating code for an ERT-based target, you
can define and use a new storage class. For more information on storage classes and storage class
properties, see “Choose Storage Class for Controlling Data Representation in Generated Code” on
page 34-74.

When to Configure Data by Using a Data Object

For most model-owned data, you can map a storage class directly to a data item by using the Code
Mappings editor or code mapping API. You must configure some data that your model uses for code
generation by using a data object, including:

• Parameters — Includes parameters in the base workspace, model workspace, or data dictionary.
Configure parameters by using a Simulink.Parameter object.

• Global data stores — Configure by using a signal object.

Before configuring numeric variables for code generation, you must convert them to
Simulink.Parameter objects.

Configure Model-Owned Data by Using Code Mapping

Model-owned data consists of outport blocks, signal lines, block states, data stores, and parameter
objects in the model workspace. For this data, you can map a storage class to a data element in the
coder app by using the Code Mappings editor or by using the code mappings API. For convenience,
you can also configure external data objects in the Code Mappings editor, though for external data
objects, the storage class is stored on the data object and not in the model. To see these objects, in
the editor, click the Refresh link to the right of the category name.

To configure model-owned data, you first configure default code generation settings for categories of
data elements. Using a default mapping saves time and reduces the risk of introducing errors in the
code, especially when your model contains a significant number of elements in a particular category.

• In the C Code tab, select Code Interface > Default Code Mappings.
• On the Data Defaults tab, select a data category, then select a default storage class for that

category. If you do not specify a storage class for a category, the Default storage class applies. In
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this case, the code generator places the code for the category of data elements in standard
structures. Other storage class options include:

• Relevant built-in storage classes, such as ExportedGlobal.
• Relevant storage classes in an available package, such as ImportFromFile (requires

Embedded Coder).
• Storage classes defined in an Embedded Coder Dictionary (requires Embedded Coder). For

more information on available storage classes, see “Choose Storage Class for Controlling Data
Representation in Generated Code” on page 34-74.

• In the Property Inspector, configure the properties for that storage class. (For example, header
and definition files).

For more information, see “C Code Generation Configuration for Model Interface Elements” on page
33-2.

For certain categories of data, including inports, outports, data stores, and block states, the default
mapping is likely the only configuration you need to perform. But for data elements such as
parameters and internal signals, you might need to specify an individual mapping to prevent the data
from being optimized away. To apply a storage class to an individual data element:

• In the Code Mappings editor, find the data element on its corresponding category tab (for
example, to configure an individual parameter, select the Parameters tab).

• Select a storage class for the data element. To apply the default configuration, select the storage
class Model default.

• In the Property Inspector, configure the properties for that storage class. (For example, header
and definition files).

For more information, see “C Code Generation Configuration for Model Interface Elements” on page
33-2.

Configure External Data

Configure external data objects for code generation by using the Code Mappings editor or the Model
Explorer. Select a data object in the Contents pane. Then, in the Dialog pane, on the Code
Generation tab, select a storage class and set properties for that storage class. For convenience, you
can also configure external data objects in the Code Mappings editor. To view and configure these
objects, in the editor, click the Refresh link to the right of the category name.

You can configure external data objects programmatically. For example, to configure a
Simulink.Parameter object for code generation by applying the storage class ExportedGlobal,
you can use code similar to:

P = Simulink.Parameter;
P.Value = 5;
P.DataType = 'int32';
P.CoderInfo.StorageClass = 'ExportedGlobal';

Load Storage Class Packages into Embedded Coder Dictionary

To apply a storage class from a storage class package other than Simulink (such as a package that
you create):

1 Open the Embedded Coder app.
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2 Open the Embedded Coder Dictionary. On the C Code tab, select Code Interface > Embedded
Coder Dictionary.

3 In the Embedded Coder Dictionary, click the Manage Packages button.
4 In the Manage Packages dialog box, select a package. If the package of interest is not in the list,

click Refresh. Then, select your package.
5 Close the Embedded Coder Dictionary.
6 Click Load.
7 Use the Code Mappings editor or code mappings API to configure the model's interface elements.

For more information, see Embedded Coder Dictionary, Code Mappings editor, and
coder.mapping.api.CodeMapping.

To apply the storage class by using a data object (required parameters), instead of creating a
Simulink.Signal or Simulink.Parameter object, create a myPackage.Signal or
myPackage.Parameter object. To create data objects from your package, see “Create Data Objects
from Another Data Class Package”. For an example that shows how to create and apply your own
storage class, see “Create and Apply a Storage Class” on page 38-15.

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

More About
• “Choose Storage Class for Controlling Data Representation in Generated Code”
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “C Code Generation Configuration for Model Interface Elements”
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Choose Storage Class for Controlling Data Representation in
Generated Code

A storage class is a code generation setting that you apply to data, such as parameters, signals, and
states. During code configuration, use a storage class to control the appearance and placement of a
data element in the generated code and to prevent optimizations from eliminating storage for that
data element.

For model data, you can apply a storage class directly to a model data element by using the Code
Mappings editor or code mappings API. Using either the editor or the API, apply a default storage
class for categories of data, and then override that setting, as needed, for individual data elements.

For external data, you apply a storage class to a data object by using the Model Explorer or
programmatically by using functions such as get_param and set_param.

Once you have specified a storage class for an element or category of elements, you can set
properties for that storage class, such as header files, definition files, and memory sections.

Storage Class Properties
The property settings for a storage class define how and where the code generator represents data in
the generated code. The properties that you can configure vary depending on the storage class. For
most individual elements, you can configure an identifier for naming the data element in the code. To
identify properties that you can configure for predefined storage classes, see the following
information on specific storage classes.

When you create a storage class by using the Custom Storage Class Designer, you can choose
whether the user of the storage class can specify additional settings. See “Allow Users of Storage
Class to Specify Property Value” on page 38-19.

Default Storage Class
By default, the storage class for an individual data element is Auto. By using this default value, you
are choosing to have the code generator handle storage class selection and application. In this case,
the data element is subject to code generation optimizations, which can eliminate the element from
the code or change the representation of the element. If optimizations do not eliminate the data
element, the element appears as a field of a standard data structure in the generated code.

When using the Code Mappings editor or the code mappings API, a data element configured with
storage class Auto that is not eliminated by optimizations acquires the default code generation
settings for the corresponding data category. If you do not specify a code configuration for a category
of data elements, the storage class is Default. When a data element category is using this storage
class, data elements in that category appear as a field of a standard data structure in the generated
code.

Built-in and Predefined Storage Classes
To prevent optimizations from eliminating storage for a data element, you can choose a storage class
for the element based on your code generation requirements. Available storage classes include built-
in storage classes, predefined storage classes in the Simulink package, and might also include other
project-specific storage classes defined in an Embedded Coder Dictionary. If you have special
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requirements that are not met by the listed storage classes and you are generating code for an ERT-
based target, you can define and use a new storage class. See “Define Storage Classes, Memory
Sections, and Function Templates for Software Architecture” on page 31-2 and “Create Storage
Classes by Using the Custom Storage Class Designer” on page 38-15.

For Simulink Coder, you can choose from these built-in and predefined storage classes.

Requirements Storage Class
Enable optimizations, potentially generating more efficient
code.

“Auto” on page 34-76 (Individual data
elements)

For data elements that cannot be optimized away, represent
data as a field of a standard data structure.

“Default” on page 34-76 (Default
mapping)

Prevent optimizations from eliminating storage for a data
element.

“Model Default” on page 34-76
(Individual mapping)

Access data from an unstructured global variable.
Generated code contains the variable declaration and
definition.

“ExportedGlobal” on page 34-77

Access data from an unstructured global variable.
Generated code contains the variable declaration. Your
external code provides the definition.

“ImportedExtern,
ImportedExternPointer” on page 34-
77

If you have Embedded Coder, you can choose from these additional predefined storage classes
available in the Simulink package.

Requirements Storage Class
Prevent optimizations from eliminating storage for a data
element.

“Dictionary Default” on page 34-76
(Default mapping)

Generate unstructured variables. • “ExportToFile” on page 34-79
• “ImportFromFile” on page 34-80
• “FileScope” on page 34-80
• “Localizable” on page 34-81
• “Reusable” on page 34-81
• “Const, Volatile, and ConstVolatile”

on page 34-78
Generate variables as fields of a structure. • “Struct” on page 34-82

• “Bitfield” on page 34-77
Generate variables that have a value that is fixed during
code compilation.

• “Define, ImportedDefine” on page
34-79

• “CompilerFlag” on page 34-78
Generate variables that you access through a function call. “GetSet” on page 34-80

These storage classes are examples of storage classes that you can add to an Embedded Coder
Dictionary. These examples are defined and made available when you prepare a model for code
generation by using the Quick Start tool.
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Requirements Storage Class
Generate global structures that contain
parameter data and signal or state data.

“ParamStruct, SignalStruct” on page 34-82

Auto
When you select this storage class, the code generator handles how to represent the data in the
generated code and can enable optimizations to operate on the data element, potentially generating
more efficient code.

Auto is the default storage class setting for each data element in a model. The data element is
subject to code generation optimizations, which can eliminate the element from the code or change
the representation of the element. For information about these optimizations, such as those on the
Configuration Parameters > Code Generation > Optimization pane, see “How Generated Code
Stores Internal Signal, State, and Parameter Data”.

Optimizations cannot eliminate some data, such as most block states, from the code. The remaining
data acquires a default storage class that you specify on the Data Defaults tab of the Code Mappings
editor (see “Configure Default Code Generation for Data” on page 33-16). If a data element cannot be
eliminated, the name of the element in the code is based on naming rules that you specify by using
model configuration parameters. See “Identifier Format Control” on page 53-15—requires
Embedded Coder.

Default
On the Data Defaults tab of the Code Mappings editor, Default is the default storage class setting
for each data element category. If you leave the storage class setting for a category at this value, data
elements that are not subject to code generation optimizations appear as a field of a standard data
structure. See “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-
49.

Model Default
When you configure an individual data element for code generation, use the Model Default storage
class to prevent optimizations from eliminating storage for a data element. See “How Generated Code
Stores Internal Signal, State, and Parameter Data”. With this storage class setting, the data element
acquires the default storage class that you specify for the corresponding data category on the Data
Defaults tab of the Code Mappings editor. The name of the data element in the code is the same as
the name in the model.

Dictionary Default
In Embedded Coder, if you link a model to a data dictionary, which includes a coder dictionary that
configures default code definitions for categories of data, you can use the Code Mappings editor to
apply the dictionary defaults. On the Data Defaults tab, select a category, then set the storage class
to Dictionary Default. For more information on configuring a default code mapping in a coder
dictionary, see “Configure Default Code Mapping in a Shared Dictionary” on page 31-10.
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ExportedGlobal
Use this built-in storage class to generate a global variable definition and declaration. By default, the
name of the variable is the name of the data element. The code declares the variable in the generated
file model.h, which you can include (#include) in your external code. The code generator does not
optimize this global variable from the generated code.

When you use this storage class, you can also configure this property.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.

For an example that uses this storage class, see “C Code Generation Configuration for Model
Interface Elements”.

ImportedExtern, ImportedExternPointer
Use the built-in storage class ImportedExtern to make a data element in a model represent a global
variable that your external code defines. The generated algorithmic code uses the variable without
defining it.

Generate code that reads from and writes to a global variable defined by your external code. The
generated code declares the variable in the generated file model_private.h so that the model
entry-point functions can read and write to the variable.

For example, you can apply the storage class ImportedExtern to a signal line, block state, or
parameter object. For imported data:

• The generated code does not initialize parameter data. Your code must initialize imported
parameter data.

• The generated initialization functions dynamically initialize some signal and state data. Unlike
data that the generated code allocates, the code does not initialize imported signal or state data to
a stored value of zero. Instead, the code immediately initializes the data to the real-world value
that you specify in Simulink.

Use ImportedExternPointer when your external code defines a data element and provides a
pointer for accessing that data. The generated code reads from and writes to that pointer. The
generated code declares the variable in the generated file model_private.h and reads and writes
to the data by dereferencing the pointer.

When you use these storage classes, you can also configure this property.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.

Bitfield
Use this storage class to generate a structure that stores Boolean data in named bit fields.

When you use this storage class, you can also configure these properties.
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Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
StructName Name of the structure for the data element in the generated code.

For an example that uses this storage class, see “Bitfields” on page 25-68.

CompilerFlag
Use this storage class to support preprocessor conditionals defined by using a compiler flag or option.

If you build the generated code by using Embedded Coder, to specify the compiler option, you can use
the model configuration parameter Configuration Parameters > Code Generation > Custom
Code > Additional build information > Defines. See Code Generation Pane: Custom Code:
Additional Build Information: Defines.

When you use this storage class, you can also configure this property.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.

For an example that uses this storage class, see “Generate Preprocessor Conditionals for Variant
Systems” on page 26-31.

Const, Volatile, and ConstVolatile
Use these storage classes to generate a global variable definition and declaration with the const,
volatile, or const and volatile type qualifiers.

When you use these storage classes, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
HeaderFile Source header file that contains declarations for global data read

by the data element and external code.
DefinitionFile Source definition file that contains definitions for global data read

by the data element and external code.
Owner Owner of global data that is defined with the code generated for

one of multiple components that use that data.
PreserveDimensions When model configuration parameter Array layout is set to Row-

major, a flag that indicates whether to preserve dimensions of a
data element that is represented in generated code as a
multidimensional array.

For an example that uses this storage class, see “Type Qualifiers” on page 25-12.
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Define, ImportedDefine
Use the Define storage class to generate a macro (#define directive) such as #define myParam
5.

Use ImportedDefine to generate code that uses a macro (#define directive) defined in a header
file in your external code. For an example, see “Macro Definitions (#define)” on page 25-54.

When you use these storage classes, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
HeaderFile Source header file that contains declarations for global data that is

read by the data element and external code.

For an example that uses this storage class, see “Macro Definitions (#define)” on page 25-54.

ExportToFile
Generate a global variable definition and declaration to an external file. You can specify the name and
placement of the files that define and declare the variable. See “Control Placement of Global Data
Definitions and Declarations in Generated Files” on page 35-2.

When you use this storage class, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
HeaderFile Source header file where the code generator places the

declarations for global data read by the data element and external
code.

DefinitionFile Source definition file where the code generator places the
definitions for global data read by the data element and external
code.

The code generator honors this setting only for single-instance
models. The setting is ignored for reusable multi-instance models
because the data definition is handled at the parent level.

Owner A component in the model hierarchy where the code generator
places a global data definition instead of placing it in the top
component of the hierarchy. Requires that you set the model
configuration parameter Use owner from data object for data
definition placement.

PreserveDimensions When model configuration parameter Array layout is set to Row-
major, a flag that indicates whether to preserve dimensions of a
data element that is represented in generated code as a
multidimensional array.
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For an example that uses this storage class, see “Definition, Initialization, and Declaration of
Parameter Data” on page 25-5.

FileScope
Use this storage class to generate a global variable definition and declaration that has the static
type qualifier. In the generated code, the scope of the variable is limited to the current file, which is
typically model.c.

In a model reference hierarchy, if a referenced model uses a parameter object (such as
Simulink.Parameter) that you create in the base workspace or a data dictionary, you cannot apply
FileScope to the object. As a workaround, move the parameter object into the model workspace of
the referenced model. Then, you can use FileScope.

When you use this storage class, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
PreserveDimensions When model configuration parameter Array layout is set to Row-

major, a flag that indicates whether to preserve dimensions of a
data element that is represented in generated code as a
multidimensional array.

GetSet
Use this storage class to generate code that interacts with data by calling custom accessor functions.
Your external code defines the data and provides the function definitions.

When you use this storage class, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
HeaderFile Source header file that contains declarations for global data that is

read by the data element and external code.
GetFunction Data element that appears in the generated code as a call to a

specified get function
SetFunction Data element that appears in the generated code as a call to a

specified set function

For an example that uses this storage class, see “Access Data Through Functions with Storage Class
GetSet” on page 38-26.

ImportFromFile
Use this storage class to generate code that reads from and writes to a global variable defined by
your external code. ImportFromFile is similar to ExportToFile, but the generated code does not
define the variable.
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When you use this storage class, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
HeaderFile Source header file that contains declarations for global data that is

read by the data element and external code.
PreserveDimensions When model configuration parameter Array layout is set to Row-

major, a flag that indicates whether to preserve dimensions of a
data element that is represented in generated code as a
multidimensional array.

For an example that uses this storage class, see “Integrate External Application Code with Code
Generated from PID Controller” on page 38-46.

Localizable
For signals, if possible, minimize the use of global storage by using local variables.

• If the variable is used in a single function, the variable is local to that function.
• If the variable is used in a single file, the variable is local to that file.
• If the variable is used in more than one function or file, the variable is a global.

Generating local variables prevents the code generator from removing the variables from the
generated code.

When you use this storage class, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
PreserveDimensions When model configuration parameter Array layout is set to Row-

major, a flag that indicates whether to preserve dimensions of a
data element that is represented in generated code as a
multidimensional array.

For an example that uses this storage class, see “Generate Local Variables with Localizable Storage
Class” on page 38-63.

Reusable
Use this storage class to reuse the same variable for multiple independent signals in a model. The
code generator stores intermediate calculations of a data path (a series of connected blocks) in a
single, reused global variable. This storage class is available only for external data objects.

You can apply this storage class only to a Simulink.Signal object that represents multiple signal
lines in a model.

When you use this storage class, you can also configure this property.
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Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.

For an example that uses this storage class, see “Specify Buffer Reuse by Using Simulink.Signal
Objects” on page 71-17.

Struct
Use this storage class to generate a global structure with a name that you can specify.

When you use this storage class, you can also configure these properties.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.
StructName Name of the structure for the data element in the generated code.

For an example that uses this storage class, see “Organize Parameter Data into a Structure by Using
Struct Storage Class” on page 33-68 and “Structures of Signals” on page 25-62.

ParamStruct, SignalStruct
Use these storage classes to generate global structures that contain parameter and signal or state
data, respectively. In a hierarchy of components (referenced models or atomic subsystems), you can
use these storage classes to create a corresponding hierarchy of structures. These storage classes
appear in the Code Mappings editor only after preparing a model for code generation by using the
Quick Start tool.

These storage classes are available only for model-owned data.

When you use these storage classes, you can also configure this property.

Property Description
Identifier Identifier string that the code generator uses to name the data

element in the generated code.

Storage Class Limitations
• When you use storage classes in the Code Mappings editor (Embedded Coder) or code mappings

API, some limitations apply. See “Limitations” on page 33-11.
• Data objects cannot use an Embedded Coder storage class and a multiword data type.
• For Embedded Coder storage classes in models that use referenced models:

• If you apply a grouped storage class, such as Struct or Bitfield, to multiple data items, you
must set the storage class Data scope property to Imported and you must provide the data
declaration in an external header file. Grouped storage classes use a single variable in the
generated code to represent multiple data objects.
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• If a parameter object exists in the base workspace or a data dictionary, and a referenced model
uses the object, you cannot apply the storage class FileScope. To apply this storage class to
the parameter object, move the object into the model workspace of the referenced model.

• You cannot apply the storage class FileScope to data items used by a data exchange interface (C
API, external mode, or ASAP2) or MAT-file logging. File-scoped data is not externally accessible.

• You cannot apply the storage class FileScope to data that is used in multiple files.

See Also

Related Examples
• “C Code Generation Configuration for Model Interface Elements”
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Configure Default C Code Generation for Categories of Data Elements and Functions” on page

33-15
• “Control Data and Function Interface in Generated Code”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Use Enumerated Data in Generated Code
In this section...
“Enumerated Data Types” on page 34-84
“Specify Integer Data Type for Enumeration” on page 34-84
“Customize Enumerated Data Type” on page 34-85
“Control Enumerated Type Implementation in Generated Code” on page 34-89
“Type Casting for Enumerations” on page 34-90
“Enumerated Type Limitations” on page 34-90

Enumerated Data Types
Enumerated data is data that is restricted to a finite set of values. An enumerated data type is a
MATLAB class that defines a set of enumerated values. Each enumerated value consists of an
enumerated name and an underlying integer which the software uses internally and in generated
code. The following is a MATLAB class definition for an enumerated data type named BasicColors,
which is used in the examples in this section.

classdef BasicColors < Simulink.IntEnumType
  enumeration
    Red(0)
    Yellow(1)
    Blue(2)
  end
end

For basic information about enumerated data types and their use in Simulink models, see “Use
Enumerated Data in Simulink Models”. For information about enumerated data types in Stateflow
charts, see “Define Enumerated Data Types” (Stateflow).

Specify Integer Data Type for Enumeration
When you specify a data type for your enumeration, you can:

• Control the size of enumerated data types in the generated code by specifying a superclass.
• Reduce RAM/ROM usage.
• Improve code portability.
• Improve integration with legacy code.

You can specify these integer data types:

• int8
• uint8
• int16
• uint16
• int32
• Simulink.IntEnumType. Specify values in the range of the signed integer for your hardware

platform.
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Use a Class Definition in a MATLAB File

To specify an integer data type size, derive your enumeration class from the integer data type.

classdef Colors < int8
   enumeration
     Red(0)
     Green(1)
     Blue(2)
   end
end

The code generator generates this code:

typedef int8_T Colors;

#define Red      ((Colors)0)
#define Green ((Colors)1)
#define Blue     ((Colors)2)

Use the Function Simulink.defineIntEnumType

To specify an integer data type size, specify the name-value pair StorageType as the integer data
type.

Simulink.defineIntEnumType('Colors',{'Red','Green','Blue'},...
[0;1;2],'StorageType','int8')

The code generator generates this code:

typedef int8_T Colors;

#define Red      ((Colors)0)
#define Green ((Colors)1)
#define Blue     ((Colors)2)

Customize Enumerated Data Type
When you generate code from a model that uses enumerated data, you can implement these static
methods to customize the behavior of the type during simulation and in generated code:

• getDefaultValue — Specifies the default value of the enumerated data type.
• getDescription — Specifies a description of the enumerated data type.
• getHeaderFile — Specifies a header file where the type is defined for generated code.
• getDataScope — Specifies whether generated code exports or imports the enumerated data type
definition to or from a separate header file.

• addClassNameToEnumNames — Specifies whether the class name becomes a prefix in generated
code.

The first of these methods, getDefaultValue, is relevant to both simulation and code generation,
and is described in “Specify a Default Enumerated Value”. The other methods are relevant only to
code generation. To customize the behavior of an enumerated type, include a version of the method in
the methods(Static) section of the enumeration class definition. If you do not want to customize
the type, omit the methods(Static) section. The table summarizes the methods and the data to
supply for each one.
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Static Method Purpose Default Value Without
Implementing Method

Custom Return Value

getDefaultValue Specifies the default
enumeration member for
the class.

First member specified in
the enumeration definition

A character vector
containing the name of an
enumeration member in
the class (see “Instantiate
Enumerations”).

getDescription Specifies a description of
the enumeration class.

'' A character vector
containing the description
of the type.

getHeaderFile Specifies the name of a
header file. The method
getDataScope
determines the
significance of the file.

'' A character vector
containing the name of the
header file that defines the
enumerated type.

By default, the generated
#include directive uses
the preprocessor delimiter
" instead of < and >. To
generate the directive
#include <myTypes.h>,
specify the custom return
value as '<myTypes.h>'.

getDataScope Specifies whether
generated code exports or
imports the definition of
the enumerated data type.
Use the method
getHeaderFile to
specify the generated or
included header file that
defines the type.

'Auto' One of: 'Auto',
'Exported', or
'Imported'.

addClassNameToEnumNa
mes

Specifies whether to prefix
the class name in
generated code.

false true or false.

Specify a Description

To specify a description for an enumerated data type, include this method in the methods(Static)
section of the enumeration class:

function retVal = getDescription() 
% GETDESCRIPTION  Optional description of the data type.
  retVal = 'description';
end

Substitute a MATLAB character vector for description. The generated code that defines the
enumerated type includes the specified description.
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Import Type Definition in Generated Code

To prevent generated code from defining an enumerated data type, which allows you to provide the
definition in an external file, include these methods in the methods(Static) section of the
enumeration class:
    function retVal = getHeaderFile()
      % GETHEADERFILE Specifies the file that defines this type in generated code.
      % The method getDataScope determines the significance of the specified file.
      retVal = 'imported_enum_type.h';
    end

    function retVal = getDataScope()
      % GETDATASCOPE Specifies whether generated code imports or exports this type.
      % Return one of:
      % 'Auto':     define type in model_types.h, or import if header file specified
      % 'Exported': define type in a generated header file
      % 'Imported': import type definition from specified header file
      % If you do not define this method, DataScope is 'Auto' by default.
      retVal = 'Imported';
    end

Instead of defining the type in model_types.h, which is the default behavior, generated code
imports the definition from the specified header file using a #include statement like:
#include "imported_enum_type.h"

Generating code does not create the imported header file. You must provide the header file, using the
file name specified by the method getHeaderFile, that defines the enumerated data type.

To create a Simulink enumeration that corresponds to your existing C-code enumeration, use the
Simulink.importExternalCTypes function.

Export Type Definition in Generated Code

To generate a separate header file that defines an enumerated data type, include these methods in
the methods(Static) section of the enumeration class:
    function retVal = getDataScope()
      % GETDATASCOPE Specifies whether generated code imports or exports this type.
      % Return one of:
      % 'Auto':     define type in model_types.h, or import if header file specified
      % 'Exported': define type in a generated header file
      % 'Imported': import type definition from specified header file
      % If you do not define this method, DataScope is 'Auto' by default.
      retVal = 'Exported';
    end

    function retVal = getHeaderFile()
      % GETHEADERFILE Specifies the file that defines this type in generated code.
      % The method getDataScope determines the significance of the specified file.
      retVal = 'exported_enum_type.h';
    end

Generated code exports the enumerated type definition to the generated header file
exported_enum_type.h.

Add Prefixes To Class Names

By default, enumerated values in generated code have the same names that they have in the
enumeration class definition. Alternatively, your code can prefix every enumerated value in an
enumeration class with the name of the class. You can use this technique to prevent identifier
conflicts or to improve the readability of the code. To specify class name prefixing, include this
method in the methods(Static) section of an enumeration class:
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    function retVal = addClassNameToEnumNames()
      % ADDCLASSNAMETOENUMNAMES Specifies whether to add the class name
      % as a prefix to enumeration member names in generated code.
      % Return true or false.
      % If you do not define this method, no prefix is added.
      retVal = true;
    end

Specify the return value as true to enable class name prefixing or as false to suppress prefixing. If
you specify true, each enumerated value in the class appears in generated code as
EnumTypeName_EnumName. For the example enumeration class BasicColors in “Enumerated Data
Types” on page 34-84, the data type definition in generated code might look like this:
#ifndef _DEFINED_TYPEDEF_FOR_BasicColors_
#define _DEFINED_TYPEDEF_FOR_BasicColors_

typedef enum {
  BasicColors_Red = 0,            /* Default value */
  BasicColors_Yellow = 1,
  BasicColors_Blue = 2,
} BasicColors;

#endif

The enumeration class name BasicColors appears as a prefix for each of the enumerated names.

Control Use of Duplicate Enumeration Member Names

When you import the enumeration data from a header file, you can control the use of duplicate
enumeration member names during code generation. Duplicate enumeration member names improve
the readability of the code. Use the model configuration parameter Duplicate enumeration
member names to allow duplicate enumeration member names in different enumeration types
during code generation or to generate an error or a warning message. You can use duplicate
enumeration member names only if two enumerations have the same StorageType and have these
specifications:

• DataScope set to 'Imported'
• StorageType set to 'int8', 'int16', 'int32', 'uint8', or 'uint16'
• Value is the same

For example:

typedef int32_T enum {
  Red = 0,
  Yellow = 1,
  Blue = 2,
}A;

typedef int32_T enum {
  Black = 0,
  Yellow = 1,
  White = 2,
}B;

You can have a Yellow enumeration member in enumeration A and B without prefixing the member
name with a class name to improve the readability of your code.
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Control Enumerated Type Implementation in Generated Code
Suppose that you define an enumerated type BasicColors. You can specify that the generated code
implement the type definition by using:

• An enum block. The native integer type of your hardware is the underlying integer type for the
enumeration members.

• A typedef statement and a series of #define macros. The typedef statement bases the
enumerated type name on a specific integer data type, such as int8. The macros associate the
enumeration members with the underlying integer values.

Implement Enumerated Type by Using enum Block

To implement the type definition by using an enum block:

• In Simulink, define the enumerated type by using a classdef block in a script file. Derive the
enumeration from the type Simulink.IntEnumType.

• Alternatively, use the function Simulink.defineIntEnumType. Do not specify the property
StorageType.

When you generate code, the type definition appears in an enum block.

#ifndef _DEFINED_TYPEDEF_FOR_BasicColors_
#define _DEFINED_TYPEDEF_FOR_BasicColors_

typedef enum {
  Red = 0,            /* Default value */
  Yellow,
  Blue,
} BasicColors;

#endif

Implement Enumerated Type Using a Specific Integer Type

To implement the type definition using a typedef statement and #define macros:

• In Simulink, define the enumerated type using a classdef block in a script file. Derive the
enumeration from a specific integer type such as int8.

• Alternatively, use the function Simulink.defineIntEnumType. Specify the property
StorageType using a specific integer type such as int8.

When you generate code, the type definition appears as a typedef statement and a series of
#define macros.

#ifndef _DEFINED_TYPEDEF_FOR_BasicColors_
#define _DEFINED_TYPEDEF_FOR_BasicColors_

typedef int8_T BasicColors;

#define Red ((BasicColors)0)            /* Default value */
#define Yellow ((BasicColors)1)
#define Blue ((BasicColors)2)

#endif
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By default, the generated file model_types.h contains enumerated type definitions.

Type Casting for Enumerations
Safe Casting

A Simulink Data Type Conversion block accepts a signal of integer type. The block converts the input
to one of the underlying values of an enumerated type.

If the input value does not match an underlying value of an enumerated type value, Simulink inserts a
safe cast to replace the input value with the enumerated type default value.

Enable and Disable Safe Casting

You can enable or disable safe casting for enumerations during code generation for a Simulink Data
Type Conversion block or a Stateflow block.

To control safe casting, enable or disable the Saturate on integer overflow block parameter. The
parameter works as follows:

• Enabled: Simulink replaces a nonmatching input value with the default value of the enumerated
values during simulation. The software generates a safe cast function during code generation.

• Disabled: For a nonmatching input value, Simulink generates an error during simulation. The
software omits the safe cast function during code generation. In this case, the code is more
efficient. However, the code may be more vulnerable to run-time errors.

Safe Cast Function in Generated Code

This example shows how the safe cast function int32_T ET08_safe_cast_to_BasicColors for
the enumeration BasicColors appears in generated code when generated for 32-bit hardware.

static int32_T ET08_safe_cast_to_BasicColors(int32_T input)
{
    int32_T output;
    /* Initialize output value to default value for BasicColors (Red) */
    output = 0;
    if ((input >= 0) && (input <= 2)) {
    /* Set output value to input value if it is a member of BasicColors */
        output = input;
    }
    return output;
}

Through this function, the enumerated type’s default value is used if the input value does not match
one of underlying values of the enumerated type’s values.

If the block’s Saturate on integer overflow parameter is disabled, this function does not appear in
generated code.

Enumerated Type Limitations
• Generated code does not support logging enumerated data.
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See Also
Simulink.data.getEnumTypeInfo | Simulink.defineIntEnumType | enumeration

Related Examples
• “Use Enumerated Data in Simulink Models”
• “Simulink Enumerations”
• “Exchange Structured and Enumerated Data Between Generated and External Code” on page

36-27
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Data Stores in Generated Code
In this section...
“About Data Stores” on page 34-92
“Generate Code for Data Store Memory Blocks” on page 34-92
“Storage Classes for Data Store Memory Blocks” on page 34-93
“Data Store Buffering in Generated Code” on page 34-94
“Data Stores Shared by Instances of a Reusable Model” on page 34-97
“Structures in Generated Code Using Data Stores” on page 34-97

About Data Stores
A data store contains data that is accessible in a model hierarchy at or below the level in which the
data store is defined. Data stores can allow subsystems and referenced models to share data without
having to use I/O ports to pass the data from level to level. See “Data Stores with Data Store Memory
Blocks” for information about data stores in Simulink. This section provides additional information
about data store code generation.

Generate Code for Data Store Memory Blocks
To control the code generated for a Data Store Memory block, apply a storage class to the data store.
You can associate a Data Store Memory block with a signal object that you store in a workspace or
data dictionary, and control code generation for the block by applying the storage class to the object:

1 On the Modeling tab, click Model Data Editor.
2 In the Model Data Editor, select the Data Stores tab.
3 Begin editing the name of the target Data Store Memory block by clicking the corresponding row

in the Name column.
4 Next to the name, click the button  and select Create and Resolve.
5 In the Create New Data dialog box, set Value to Simulink.Signal. Optionally, use the

Location drop-down list to choose a workspace for storing the resulting Simulink.Signal
object.

6 Click Create. The Simulink.Signal object, which has the same name as the data store,
appears in the target workspace. Simulink selects the block parameter Data store name must
resolve to Simulink signal object.

When the property dialog box for the object opens, click OK.
7 In the Simulink Coder or Embedded Coder app, open the Code Mappings editor. In the C

Code tab, select Code Interface > Individual Element Code Mappings.
8 On the Data Stores tab, apply the target storage class.

Note When a Data Store Memory block is associated with a signal object, the mapping between the
Data store name and the signal object name must be one-to-one. If two or more identically named
entities map to the same signal object, the name conflict is flagged as an error at code generation
time. See “Resolve Conflicts in Configuration of Signal Objects for Code Generation” for more
information.
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Storage Classes for Data Store Memory Blocks
You can control how Data Store Memory blocks in your model are stored and represented in the
generated code by assigning storage classes and type qualifiers. You do this in almost exactly the
same way you assign storage classes and type qualifiers for block states.

Data Store Memory blocks, like block states, have Auto storage class by default, and their memory is
stored within the DWork vector. The symbolic name of the storage location is based on the data store
name.

You can generate code from multiple Data Store Memory blocks that have the same data store name,
subject to the following restriction: at most one of the identically named blocks can have a storage
class other than Auto. An error is reported if this condition is not met.

For blocks with Auto storage class, the code generator produces a unique symbolic name for each
block to avoid name clashes. For Data Store Memory blocks with storage classes other than Auto, the
generated code uses the data store name as the symbol.

In the following model, a Data Store Write block writes to memory declared by the Data Store
Memory block myData:

To control the storage declaration for a Data Store Memory block, in the coder app, use the Code
Mappings editor. On the Data Stores tab, select a Storage Class for the block.

Data Store Memory blocks are nonvirtual because code is generated for their initialization in .c
and .cpp files and their declarations in header files. The following table shows how the code
generated for the Data Store Memory block in the preceding model differs for different storage
classes. The table gives the variable declarations and MdlOutputs code generated for the myData
block.

Storage Class Declaration Code
Auto or Model default (when
Code Mapping Editor specifies
Default storage class)

In model.h
typedef struct 
D_Work_tag 
{
  real_T myData;
} 
D_Work;

In model.c or model.cpp
/* Block states (auto storage) */
D_Work model_DWork;

model_DWork.myData = 
  rtb_SineWave;
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Storage Class Declaration Code
ExportedGlobal In model.c or model.cpp

/* Exported block states */
real_T myData; 

In model.h
extern real_T myData;

myData = rtb_SineWave;

ImportedExtern In model_private.h
extern real_T myData;

myData = rtb_SineWave;

ImportedExternPointer In model_private.h
extern real_T *myData;

(*myData) = rtb_SineWave;

For information about applying storage classes, see “C Code Generation Configuration for Model
Interface Elements” on page 33-2.

For ERT models, you can preserve dimensions of multidimensional arrays in data stores. For more
information, see “Preserve Dimensions of Multidimensional Arrays in Generated Code” on page 45-
2.

Data Store Buffering in Generated Code
A Data Store Read block is a nonvirtual block that copies the value of the data store to its output
buffer when it executes. Since the value is buffered, downstream blocks connected to the output of
the data store read utilize the same value, even if a Data Store Write block updates the data store in
between execution of two of the downstream blocks.

The next figure shows a model that uses blocks whose priorities have been modified to achieve a
particular order of execution:
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The following execution order applies:

1 The block Data Store Read buffers the current value of the data store A at its output.
2 The block Abs1 uses the buffered output of Data Store Read.
3 The block Data Store Write updates the data store.
4 The block Abs uses the buffered output of Data Store Read.

Because the output of Data Store Read is a buffer, both Abs and Abs1 use the same value: the value of
the data store at the time that Data Store Read executes.

The next figure shows another example:
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In this example, the following execution order applies:

1 The block Data Store Read buffers the current value of the data store A at its output.
2 Atomic Subsystem executes.
3 The Sum block adds the output of Atomic Subsystem to the output of Data Store Read.

Simulink assumes that Atomic Subsystem might update the data store, so Simulink buffers the data
store. Atomic Subsystem executes after Data Store Read buffers its output, and the buffer provides a
way for the Sum block to use the value of the data store as it was when Data Store Read executed.

In some cases, the code generator determines that it can optimize away the output buffer for a Data
Store Read block, and the generated code refers to the data store directly, rather than a buffered
value of it. The next figure shows an example:
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In the generated code, the argument of the fabs() function is the data store A rather than a buffered
value.

Data Stores Shared by Instances of a Reusable Model
You can use a data store to share a piece of data between the instances of a reusable referenced
model (see “Share Data Among Referenced Model Instances”) or a model that you configure to
generate reentrant code (by setting the configuration parameter Code interface packaging to
Reusable function). If you implement the data store as a Data Store Memory block and select the
Share across model instances parameter:

• By default, the data store appears in the generated code as a separate global symbol.
• If you have Embedded Coder, to restrict access such that only the code generated from the model

can use the data store, configure the data store to appear as static by applying the storage class
FileScope. For more information about FileScope and other storage classes, see “Choose
Storage Class for Controlling Data Representation in Generated Code” on page 34-74.

Structures in Generated Code Using Data Stores
If you use more than one data store to provide global access to multiple signals in generated code,
you can combine the signals into a single structure variable by using one data store. This combination
of signal data can help you integrate the code generated from a model with other existing code that
requires the data in a structure format.

This example shows how to store several model signals in a structure in generated code using a
single data store. To store multiple signals in a data store, you configure the data store to accept a
composite signal, such as a nonvirtual bus signal or an array of nonvirtual bus signals.

Explore Example Model

1 Open the example model ex_bus_struct_in_code.

The model contains three subsystems that perform calculations on the inputs from the top level
of the model. In each subsystem, a Data Store Memory block stores an intermediate calculated
signal.

2 Generate code with the model. In the code generation report, view the file
ex_bus_struct_in_code.c. The code defines a global variable for each data store.

real_T BioBTURate;
real_T CoalBTURate;
real_T GasBTURate;

Suppose that you want to integrate code generated from the example model with other existing code.
Suppose also that the existing code requires access to data from the three data stores in a single
structure variable. You can use a data store to assemble the target data in a structure in generated
code.

Configure Data Store

Configure a data store to contain multiple signals by creating a bus type to use as the data type of the
data store. Define the bus type using the same hierarchy of elements as the structure that you want
to appear in generated code.
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1 Open the Bus Editor tool.

buseditor
2 Define a new bus type Raw_BTU_Rate with one element for each of the three target signals.

Name the elements BioBTU, GasBTU, and CoalBTU.

3 At the top level of the example model, add a Data Store Memory block.
4 On the Modeling tab, click Model Data Editor.
5 In the Model Data Editor, inspect the Data Stores tab.
6 For the new Data Store Memory block, use the Name column to set the data store name to

Raw_BTU_Data.
7 Use the Data Type column to set the data type of the data store to Bus: Raw_BTU_Rate.
8 In the Code Mappings editor, on the Data Stores tab, apply the storage class ExportedGlobal

to Raw_BTU_Data.

Write to Data Store Elements

To write to a specific element of a data store, use a Data Store Write block. On the Element
Assignment tab in the dialog box, you can specify to write to a single element, a collection of
elements, or the entire contents of a data store.

1 Open the Biomass Calc subsystem.
2 Delete the Data Store Memory block BioBTURate.
3 In the block dialog box for the Data Store Write block, set Data store name to Raw_BTU_Data.
4 On the Element Assignment tab, under Signals in the bus, expand the contents of the data

store Raw_BTU_Data. Click the element BioBTU, and then click Select. Click OK.
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5 Modify the Gas Calc and Coal Calc subsystems similarly.

• Delete the Data Store Memory block in each subsystem.
• In each Data Store Write block dialog box, set Data store name to Raw_BTU_Data.
• In the Gas Calc subsystem, use the Data Store Write block to write to the data store element

GasBTU. In the Coal Calc subsystem, write to the element CoalBTU.

Generate Code with Data Store Structure

1 Generate code for the example model.
2 In the code generation report, view the file ex_bus_struct_in_code_types.h. The code

defines a structure that corresponds to the bus type Raw_BTU_Rate.

typedef struct {
  real_T BioBTU;
  real_T GasBTU;
  real_T CoalBTU;
} Raw_BTU_Rate;

3 View the file ex_bus_struct_in_code.c. The code represents the data store with a global
variable Raw_BTU_Data of the structure type Raw_BTU_Rate. In the model step function, the
code assigns the data from the calculated signals to the fields of the global variable
Raw_BTU_Data.
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See Also

Related Examples
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Structures in Generated Code Using Data Stores” on page 34-97
• “When to Use a Data Store”
• “Generate Code That Dereferences Data from a Literal Memory Address” on page 66-16
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Specify Single-Precision Data Type for Embedded Application
When you want code that uses only single precision, such as when you are targeting a single-
precision processor, you can use model configuration parameters and block parameters to prevent
the introduction of double in the model.

To design and validate a single-precision model, see “Validate a Floating-Point Embedded Model”. If
you have Fixed-Point Designer, you can use the Single Precision Converter app (see Single Precision
Converter).

Use single Data Type as Default for Underspecified Types
This example shows how to avoid introducing a double-precision data type in code generated for a
single-precision hardware target.

If you specify an inherited data type for signals, but data type propagation rules cannot determine
data types for the signals, the signal data types default to double. You can use a model configuration
parameter to specify the default data type as single.

Explore Example Model

Open the example model rtwdemo_underspecified_datatype and configure it to show the generated
names of blocks.

model = 'rtwdemo_underspecified_datatype';
load_system(model)
set_param(model,'HideAutomaticNames','off')
open_system(model);
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The root inports In2, In3, and In4 specify Inherit: Auto for the Data type block parameter. The
downstream blocks also use inherited data types.

Generate Code with double as Default Data Type

The model starts with the configuration parameter System target file set to ert.tlc, which
requires Embedded Coder. Set System target file to grt.tlc instead.

set_param(model,'SystemTargetFile','grt.tlc')

Generate code from the model.

slbuild(model)

### Starting build procedure for: rtwdemo_underspecified_datatype
### Successful completion of build procedure for: rtwdemo_underspecified_datatype

Build Summary

Top model targets built:

Model                            Action                       Rebuild Reason                                    
================================================================================================================
rtwdemo_underspecified_datatype  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.635s

In the code generation report, view the file rtwdemo_underspecified_datatype.h. The code
uses the double data type to define the variables In2, In3, and In4 because the Inport data types
are underspecified in the model.

cfile = fullfile('rtwdemo_underspecified_datatype_grt_rtw',...
    'rtwdemo_underspecified_datatype.h');
rtwdemodbtype(cfile,...
    '/* External inputs (root inport signals with default storage) */',...
    '/* External outputs (root outports fed by signals with default storage) */',...
    1, 0);

/* External inputs (root inport signals with default storage) */
typedef struct {
  int8_T In1;                          /* '<Root>/In1' */
  real_T In2;                          /* '<Root>/In2' */
  real_T In3;                          /* '<Root>/In3' */
  real_T In4;                          /* '<Root>/In4' */
} ExtU_rtwdemo_underspecified_d_T;

Generate Code with single as Default Data Type

Open the Configuration Parameters dialog box. On the Math and Data Types pane, select single in
the Default for underspecified data type drop-down list.

Alternatively, enable the optimization at the command prompt.

set_param(model, 'DefaultUnderspecifiedDataType', 'single');

Generate code from the model.
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slbuild(model)

### Starting build procedure for: rtwdemo_underspecified_datatype
### Successful completion of build procedure for: rtwdemo_underspecified_datatype

Build Summary

Top model targets built:

Model                            Action                       Rebuild Reason                   
===============================================================================================
rtwdemo_underspecified_datatype  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.809s

In the code generation report, view the file rtwdemo_underspecified_datatype.h. The code
uses the single data type to define the variables In2, In3, and In4.

rtwdemodbtype(cfile,...
    '/* External inputs (root inport signals with default storage) */',...
    '/* External outputs (root outports fed by signals with default storage) */',...
    1, 0);

/* External inputs (root inport signals with default storage) */
typedef struct {
  int8_T In1;                          /* '<Root>/In1' */
  real32_T In2;                        /* '<Root>/In2' */
  real32_T In3;                        /* '<Root>/In3' */
  real32_T In4;                        /* '<Root>/In4' */
} ExtU_rtwdemo_underspecified_d_T;

See Also

Related Examples
• “Default for underspecified data type”
• “Subnormal Number Execution Speed” on page 69-16
• “Standard math library”
• “Control Data Type Names in Generated Code” on page 36-2
• “About Data Types in Simulink”
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Tune Phase Parameter of Sine Wave Block During Code
Execution

Under certain conditions, you cannot configure the Phase parameter of a Sine Wave block to appear
in the generated code as a tunable global variable (for more information, see the block reference
page). This example shows how to generate code so that you can tune the phase during execution.

Create the model ex_phase_tunable by using a Digital Clock block.

open_system('ex_phase_tunable')

Set Default parameter behavior to Tunable so that the parameters of the Sine Wave block appear
in the generated code as tunable fields of the global parameter structure.

set_param('ex_phase_tunable','DefaultParameterBehavior','Tunable')

Generate code from the model.

slbuild('ex_phase_tunable')

### Starting build procedure for: ex_phase_tunable
### Successful completion of code generation for: ex_phase_tunable

Build Summary

Top model targets built:

Model             Action          Rebuild Reason                                    
====================================================================================
ex_phase_tunable  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.761s

In the code generation report, view the file ex_phase_tunable.c. The code algorithm in the model
step function calculates the Sine Wave block output. The parameters of the block, including Phase,
appear in the code as tunable structure fields.

file = fullfile('ex_phase_tunable_grt_rtw','ex_phase_tunable.c');
rtwdemodbtype(file,'/* Outport: ''<Root>/Out1'' incorporates:',...
    'ex_phase_tunable_P.SineWave_Bias;',1,1)

  /* Outport: '<Root>/Out1' incorporates:
   *  DigitalClock: '<Root>/Digital Clock'
   *  Sin: '<Root>/Sine Wave'
   */
  ex_phase_tunable_Y.Out1 = sin(ex_phase_tunable_P.SineWave_Freq *
    (((ex_phase_tunable_M->Timing.clockTick1+
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       ex_phase_tunable_M->Timing.clockTickH1* 4294967296.0)) * 1.0) +
    ex_phase_tunable_P.SineWave_Phase) * ex_phase_tunable_P.SineWave_Amp +
    ex_phase_tunable_P.SineWave_Bias;

During code execution, you can assign new values to the structure field that corresponds to the
Phase parameter.

See Also

Related Examples
• “Preserve Variables in Generated Code” on page 34-2
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Switch Between Output Waveforms During Code Execution for
Waveform Generator Block

This example shows how to generate code that enables you to switch between stimulus waveforms
during code execution.

For a Waveform Generator block, you cannot make the parameters of a waveform, such as amplitude
and phase shift, tunable in the generated code. Instead, you can generate code that enables you to
choose an active waveform from a set of waveform variants that you specify in the block. During
execution of the code, you activate a variant by adjusting the value of a global structure field.

You must set the model configuration parameter Default parameter behavior to Tunable. Then, by
default, block parameters in the model appear tunable in the generated code. These parameters can
consume large amounts of memory for a large model.

Create the model ex_switch_waveform.

open_system('ex_switch_waveform')

In the Waveform Generator block, configure this waveform:

square(amp,10,0,dutyCycle)

In the base workspace, create the variables amp and dutyCycle.

amp = 2.71;
dutyCycle = 50;

This waveform represents the baseline stimulus that you want the application to use at the start of
execution.

Suppose that, during execution, you want to observe the effects of changing the waveform frequency
from 10 to 15 and the phase shift from 0 to 0.5. In the Waveform Generator block, add these
waveform variants:

square(amp,10,0.5,dutyCycle)
square(amp,15,0,dutyCycle)
square(amp,15,0.5,dutyCycle)

Set the model configuration parameter Default parameter behavior to Tunable.

set_param('ex_switch_waveform','DefaultParameterBehavior','Tunable')

Generate code from the model.

slbuild('ex_switch_waveform')
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### Starting build procedure for: ex_switch_waveform
### Successful completion of code generation for: ex_switch_waveform

Build Summary

Top model targets built:

Model               Action          Rebuild Reason                                    
======================================================================================
ex_switch_waveform  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 9.442s

The generated file ex_switch_waveform.h defines the standard structure type that stores tunable
parameter data for the model. The structure contains a field whose value represents the active
waveform.

file = fullfile('ex_switch_waveform_grt_rtw','ex_switch_waveform.h');
rtwdemodbtype(file,'/* Parameters (default storage) */',...
    '/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */
struct P_ex_switch_waveform_T_ {
  real_T WaveformGeneratorStimulus_Selec;
                              /* Mask Parameter: WaveformGeneratorStimulus_Selec
                               * Referenced by: '<S1>/Switch'
                               */
  real_T GainControlSystem_Gain;       /* Expression: 3.5
                                        * Referenced by: '<Root>/Gain (Control System)'
                                        */
};

The file ex_switch_waveform_data.c defines a global structure variable and initializes the field
value to 1. This value represents the baseline waveform.

file = fullfile('ex_switch_waveform_grt_rtw','ex_switch_waveform_data.c');
rtwdemodbtype(file,'/* Block parameters (default storage) */','};',1,1)

/* Block parameters (default storage) */
P_ex_switch_waveform_T ex_switch_waveform_P = {
  /* Mask Parameter: WaveformGeneratorStimulus_Selec
   * Referenced by: '<S1>/Switch'
   */
  1.0,

  /* Expression: 3.5
   * Referenced by: '<Root>/Gain (Control System)'
   */
  3.5
};

The file ex_switch_waveform.c defines the model execution function. The function uses a switch
statement to determine the value of the active waveform, and then calculates the value of the root-
level Outport block, Out1.
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file = fullfile('ex_switch_waveform_grt_rtw','ex_switch_waveform.c');
rtwdemodbtype(file,'switch ((int32_T)',...
    'ex_switch_waveform_Y.Out1 =',1,1)

  switch ((int32_T)ex_switch_waveform_P.WaveformGeneratorStimulus_Selec) {
   case 1:
    temp = temp - floor(temp) <= 0.5 ? 2.71 : -2.71;
    break;

   case 2:
    temp = temp_0 - floor(temp_0) <= 0.5 ? 2.71 : -2.71;
    break;

   case 3:
    temp = temp_1 - floor(temp_1) <= 0.5 ? 2.71 : -2.71;
    break;

   default:
    temp = temp_2 - floor(temp_2) <= 0.5 ? 2.71 : -2.71;
    break;
  }

  /* End of MultiPortSwitch: '<S1>/MultiportSwitch' */

  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain (Control System)'
   */
  ex_switch_waveform_Y.Out1 = ex_switch_waveform_P.GainControlSystem_Gain * temp;

During code execution, to change the active waveform, adjust the value of the structure field in the
global parameters structure.

See Also

Related Examples
• “Preserve Variables in Generated Code” on page 34-2
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Create Tunable Calibration Parameter in the Generated Code
A calibration parameter is a value stored in global memory that an algorithm reads for use in
calculations but does not write to. Calibration parameters are tunable because you can change the
stored value during algorithm execution. You create calibration parameters so that you can:

• Determine an optimal parameter value by tuning the parameter and monitoring signal values
during execution.

• Efficiently adapt an algorithm to different execution conditions by overwriting the parameter
value stored in memory. For example, you can use the same control algorithm for multiple vehicles
of different masses by storing different parameter values in each vehicle’s engine control unit.

In Simulink, create a Simulink.Parameter object to represent a calibration parameter. You use the
parameter object to set block parameter values, such as the Gain parameter of a Gain block. To
control the representation of the parameter object in the generated code, you apply a storage class to
the object.

To make block parameters accessible in the generated code by default, for example for rapid
prototyping, set Default parameter behavior (see “Default parameter behavior”) to Tunable. For
more information, see “Preserve Variables in Generated Code” on page 34-2.

Represent Block Parameter as Tunable Global Variable
This example shows how to create tunable parameter data by representing block parameters as
global variables in the generated code.

Configure Block Parameter by Using Parameter Object

Open the example model rtwdemo_paraminline and configure it to show the generated names of
blocks.

load_system('rtwdemo_paraminline')
set_param('rtwdemo_paraminline','HideAutomaticNames','off')
open_system('rtwdemo_paraminline')
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On the Modeling tab, click Model Data Editor.

In the Model Data Editor, inspect the Parameters tab.

In the model, click the G1 Gain block. The Model Data Editor highlights the row that corresponds to
the Gain parameter of the block.

In the Model Data Editor Value column, change the gain value from 2 to myGainParam.

Next to myGainParam, click the action button (with three vertical dots) and select Create.

In the Create New Data block dialog box, set Value to Simulink.Parameter(2). Click Create. A
Simulink.Parameter object myGainParam stores the parameter value, 2, in the model workspace.

In the myGainParam dialog box, on the Code Generation tab, click Configure in Coder App.

In the Code Mappings editor, set Storage Class of myGainParam to ExportedGlobal. This storage
class causes the parameter object to appear in the generated code as a tunable global variable.

Alternatively, to create the parameter object and configure the model, use these commands at the
command prompt:

set_param('rtwdemo_paraminline/G1','Gain','myGainParam')
mws = get_param('rtwdemo_paraminline', 'modelworkspace');
mws.assignin('myGainParam',Simulink.Parameter(2));
cm = coder.mapping.utils.create('rtwdemo_paraminline');
setModelParameter(cm,'myGainParam','StorageClass','ExportedGlobal');

Use the Model Data Editor to create a parameter object, myOtherGain, for the G2 Gain block. Apply
the storage class ExportedGlobal.

Alternatively, use these commands at the command prompt:
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set_param('rtwdemo_paraminline/G2','Gain','myOtherGain')
mws.assignin('myOtherGain',Simulink.Parameter(-2));
setModelParameter(cm,'myOtherGain','StorageClass','ExportedGlobal');

Generate and Inspect Code

Generate code from the model.

slbuild('rtwdemo_paraminline')

### Starting build procedure for: rtwdemo_paraminline
### Successful completion of build procedure for: rtwdemo_paraminline

Build Summary

Top model targets built:

Model                Action                       Rebuild Reason                                    
====================================================================================================
rtwdemo_paraminline  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 9.502s

The generated file rtwdemo_paraminline.h contains extern declarations of the global variables
myGainParam and myOtherGain. You can include (#include) this header file so that your code can
read and write the value of the variable during execution.

file = fullfile('rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.h');
rtwdemodbtype(file,...
    'extern real_T myGainParam;','Referenced by: ''<Root>/G2''',1,1)

extern real_T myGainParam;             /* Variable: myGainParam
                                        * Referenced by: '<Root>/G1'
                                        */
extern real_T myOtherGain;             /* Variable: myOtherGain
                                        * Referenced by: '<Root>/G2'

The file rtwdemo_paraminline.c allocates memory for and initializes myGainParam and
myOtherGain.

file = fullfile('rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.c');
rtwdemodbtype(file,...
    '/* Exported block parameters */','Referenced by: ''<Root>/G2''',1,1)

/* Exported block parameters */
real_T myGainParam = 2.0;              /* Variable: myGainParam
                                        * Referenced by: '<Root>/G1'
                                        */
real_T myOtherGain = -2.0;             /* Variable: myOtherGain
                                        * Referenced by: '<Root>/G2'

The generated code algorithm in the model step function uses myGainParam and myOtherGain for
calculations.

rtwdemodbtype(file,...
    '/* Model step function */','/* Model initialize function */',1,0)
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/* Model step function */
void rtwdemo_paraminline_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/G1'
   *  Gain: '<Root>/G2'
   *  Inport: '<Root>/In1'
   *  Sum: '<Root>/Sum'
   */
  rtwdemo_paraminline_Y.Out1 = myGainParam * rtwdemo_paraminline_U.In1 +
    myOtherGain * -75.0;
}

Apply Storage Class When Block Parameter Refers to Numeric MATLAB
Variable
If you use a numeric variable to set the value of a block parameter, you cannot apply a storage class
to the variable. As a workaround, you can convert the variable to a parameter object, and then apply
a storage class to the object. To convert the variable to a parameter object, choose one of these
techniques:

• On the Model Data Editor Parameters tab, with Change view set to Code, find the row that
corresponds to the variable. In the Storage Class column, from the drop-down list, select
Convert to parameter object. The Model Data Editor converts the variable to a parameter
object. Then, use the Storage Class column to apply a storage class to the object.

You can also use this technique in the Model Explorer.
• Use the Data Object Wizard (see “Create Data Objects for a Model Using Data Object Wizard”). In

the Wizard, select the Parameters check box. The Wizard converts variables to objects. Then,
apply storage classes to the objects, for example, by using the Model Data Editor or the Model
Explorer.

Create Storage Class That Represents Calibration Parameters
(Embedded Coder)
This example shows how to create a storage class that yields a calibration parameter in the generated
code. The storage class causes each parameter object (Simulink.Parameter) to appear as a global
variable with special decorations such as keywords and pragmas.

In the generated code, the calibration parameters must appear as global variables defined in a file
named calPrms.c and declared in calPrms.h. The variable definitions must look like these
definitions:

#pragma SEC(CALPRM)

const volatile float param1 = 3.0F;
const volatile float param2 = 5.0F;
const volatile float param3 = 7.0F;

#pragma SEC()
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The variables use the keywords const and volatile. The pragma #pragma SEC(CALPRM) controls
the placement of the variables in memory. To implement the pragma, variable definitions must appear
in a contiguous block of code.

Also, the generated code must include an ASAP2 (a2l) description of each parameter.

Create Package for Storing Storage Class and Memory Section Definitions

Now, create a package in your current folder by copying the example package +SimulinkDemos. The
package stores the definitions of Parameter and Signal classes that you later use to apply the
storage class to data elements in models. Later, the package also stores the definitions of the storage
class and an associated memory section.

1 Set your current MATLAB folder to a writable location.
2 Copy the +SimulinkDemos package folder into your current folder. Name the copy

+myPackage.

copyfile(fullfile(matlabroot,...
    'toolbox','simulink','simdemos','dataclasses','+SimulinkDemos'),...
    '+myPackage','f')

3 Navigate inside the +myPackage folder to the file Signal.m to edit the definition of the Signal
class.

4 Uncomment the methods section that defines the method setupCoderInfo. In the call to the
function useLocalCustomStorageClasses, replace 'packageName' with 'myPackage'.
When you finish, the section looks like this:

  methods
    function setupCoderInfo(h)
      % Use custom storage classes from this package
      useLocalCustomStorageClasses(h, 'myPackage');
    end
  end % methods

5 Save and close the file.
6 Navigate inside the +myPackage folder to the file Parameter.m to edit the definition of the

Parameter class. Uncomment the methods section that defines the method setupCoderInfo
and replace 'packageName' with 'myPackage'.

7 Save and close the file.

Create Storage Class and Memory Section

1 Set your current folder to the folder that contains the package folder +myPackage.
2 Open the Custom Storage Class Designer.

cscdesigner('myPackage')
3 In the Custom Storage Class Designer, on the Memory Sections tab, click New.
4 For the new memory section, set properties according to the table.

Property Value
Name CalMem
Statements Surround Group of variables
Pre Statement #pragma SEC(CALPRM)
Post Statement #pragma SEC()
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Property Value
Is const Select
Is volatile Select

5 Click Apply.
6 On the Custom Storage Class tab, click New.
7 For the new storage class, set properties according to the table.

Property Value
Name CalParam
For signals Clear
Data scope Exported
Header File calPrms.h
Definition File calPrms.c
Memory Section CalMem

8 Click OK. In response to the message about saving changes, click Yes.

Set Default Parameter Object to myPackage.Parameter

To make applying the storage class easier, use the Model Explorer to change the default parameter
object from Simulink.Parameter to myPackage.Parameter.

1 At the command prompt, open the Model Explorer.

daexplr
2 In the Model Explorer Model Hierarchy pane, select Base Workspace.
3 In the Model Explorer toolbar, click the arrow next to the Add Simulink Parameter button. In

the drop-down list, select Customize class lists.
4 In the Customize class lists dialog box, under Parameter classes, select the check box next to

myPackage.Parameter. Click OK.
5 In the Model Explorer toolbar, click the arrow next to the Add Simulink Parameter button. In

the drop-down list, select myPackage Parameter.

A myPackage.Parameter object appears in the base workspace. You can delete this object.

Now, when you use tools such as the Model Data Editor to create parameter objects, Simulink creates
myPackage.Parameter objects instead of Simulink.Parameter objects.

Apply Storage Class

In the example model rtwdemo_roll, the BasicRollMode subsystem represents a PID controller.
Configure the P, I, and D parameters as calibration parameters.

1 Open the model.

rtwdemo_roll
2 In the model, navigate into the BasicRollMode subsystem.
3 In the Apps gallery, click Embedded Coder.
4 Underneath the block diagram, open the Model Data Editor by selecting the Model Data Editor

tab.
5 In the Model Data Editor, select the Parameters tab and update the block diagram.

34 Data Representation in Simulink Coder

34-114



Now, the data table contains rows that correspond to workspace variables used by the Gain
blocks (which represent the P, I, and D parameters of the controller).

6 In the Model Data Editor, next to the Filter contents box, activate the Filter using selection
button.

7 In the model, select the three Gain blocks.
8 In the Filter contents box, enter model workspace.

The variables that the Gain blocks use are in the model workspace.
9 In the data table, select the three rows and, in the Storage Class column for a row, select

Convert to parameter object.

The Model Data Editor converts the workspace variables to myPackage.Parameter objects.
Now, you can apply a storage class to the objects.

10 In the Storage Class column for a row, select CalParam.

Configure Generation of ASAP2 Interface

Configure the model to generate a2l files. Select Configuration Parameters > Code Generation >
Interface > ASAP2 interface.

Generate and Inspect Code

1 Generate code from the model.
2 In the code generation report, inspect the calPrms.c file. The file defines the calibration

parameters.

/* Exported data definition */
#pragma SEC(CALPRM)

/* Definition for custom storage class: CalParam */
const volatile real32_T dispGain = 0.75F;
const volatile real32_T intGain = 0.5F;
const volatile real32_T rateGain = 2.0F;

#pragma SEC()

The file calPrms.h declares the parameters.
3 Inspect the interface file rtwdemo_roll.a2l. The file contains information about each

parameter, for example, for dispGain.

/begin CHARACTERISTIC
  /* Name                   */      dispGain  
  /* Long Identifier        */      ""
  /* Type                   */      VALUE 
  /* ECU Address            */      0x0000 /* @ECU_Address@dispGain@ */ 
  /* Record Layout          */      Scalar_FLOAT32_IEEE 
  /* Maximum Difference     */      0 
  /* Conversion Method      */      rtwdemo_roll_CM_single 
  /* Lower Limit            */      -3.4E+38 
  /* Upper Limit            */      3.4E+38
/end CHARACTERISTIC
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Initialize Parameter Value From System Constant or Other Macro
(Embedded Coder)
You can generate code that initializes a tunable parameter with a value calculated from some system
constants (macros). For example, you can generate this code, which initializes a tunable parameter
totalVol with a value calculated from macros numVessels and vesInitVol:

#define numVessels 16
#define vesInitVol 18.2

double totalVol = numVessels * vesInitVol;

This initialization technique preserves the mathematical relationship between the tunable parameter
and the system constants, which can make the generated code more readable and easier to maintain.
To generate this code:

1 Create parameter objects that represent the system constants.

numVessels = Simulink.Parameter(16);
vesInitVol = Simulink.Parameter(18.2);

2 Configure the objects to use the storage class Define, which yields a macro in the generated
code.

numVessels.CoderInfo.StorageClass = 'Custom';
numVessels.CoderInfo.CustomStorageClass = 'Define';

vesInitVol.CoderInfo.StorageClass = 'Custom';
vesInitVol.CoderInfo.CustomStorageClass = 'Define';

3 Create another parameter object that represents the tunable parameter. Configure the object to
use the storage class ExportedGlobal, which yields a global variable in the generated code.

totalVol = Simulink.Parameter;
totalVol.CoderInfo.StorageClass = 'ExportedGlobal';

4 Set the value of totalVol by using the expression numVessels * vesInitVol. To specify that
the generated code preserve the expression, use the slexpr function.

totalVol.Value = slexpr('numVessels * vesInitVol');
5 Use totalVol to set block parameter values in your model. The code that you generate from the

model initializes the tunable parameter with a value based on the system constants.

For more information and limitations about using an expression to set the value of a
Simulink.Parameter object, see “Set Variable Value by Using a Mathematical Expression”.

Code Generation Impact of Storage Location for Parameter Objects
You can create a parameter object in the base workspace, a model workspace, or a data dictionary.
However, when you end your MATLAB session, variables in the base workspace are deleted. To
determine where to store parameter objects and other variables that a model uses, see “Determine
Where to Store Variables and Objects for Simulink Models”.

The location of a parameter object can impact the file placement of the corresponding data definition
in the generated code.
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• If you place a parameter object in the base workspace or a data dictionary, the code generator
assumes that the corresponding parameter data (for example, a global variable) belongs to the
system from which you generate code, not to a specific component in the system. For example, if a
model in a model reference hierarchy uses a parameter object with a storage class other than
Auto, the data definition appears in the code generated for the top model in the hierarchy, not in
the code generated for the model that uses the object.

However, if you have Embedded Coder, some storage classes enable you to specify the name of the
model that owns a piece of data. When you specify an owner model, the code generated for that
model defines the data. For more information about data ownership, see “Control Placement of
Global Data Definitions and Declarations in Generated Files” on page 35-2.

• If you place a parameter object in a model workspace, the code generator assumes that the model
owns the data. If you generate code from a reference hierarchy that includes the containing
model, the data definition appears in the code generated for the containing model.

For more information about data ownership, see “Control Placement of Global Data Definitions
and Declarations in Generated Files” on page 35-2.

• If you apply a storage class other than Auto to a parameter object, the object appears in the
generated code as a global symbol. Therefore, in a model reference hierarchy, two such objects in
different model workspaces or dictionaries cannot have the same name. The name of each object
must be unique throughout the model hierarchy.

However, if you have Embedded Coder, you can use the storage class FileScope to prevent name
clashes between parameter objects in different model workspaces. See “Organize Parameter Data
into a Structure by Using Struct Storage Class” on page 33-68.

If you store an AUTOSAR.Parameter object in a model workspace, the code generator ignores the
storage class that you specify for the object.

Configure Accessibility of Signal Data
When you tune the value of a parameter during algorithm execution, you monitor or capture output
signal values to analyze the results of the tuning. To represent signals in the generated code as
accessible data, you can use techniques such as test points and storage classes. See “Preserve
Variables in Generated Code” on page 34-2.

Programmatic Interfaces for Tuning Parameters
You can configure the generated code to include:

• A C application programming interface (API) for tuning parameters independent of external mode.
The generated code includes extra code so that you can write your own code to access parameter
values. See “Exchange Data Between Generated and External Code Using C API” on page 60-2.

• A Target Language Compiler API for tuning parameters independently of external mode. See
“Parameter Functions”.

Set Tunable Parameter Minimum and Maximum Values
It is a best practice to specify minimum and maximum values for tunable parameters.

You can specify these minimum and maximum values:
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• In the block dialog box that uses the parameter object. Use this technique to store the minimum
and maximum information in the model.

• By using the properties of a Simulink.Parameter object that you use to set the parameter
value. Use this technique to store the minimum and maximum information outside the model.

For more information, see “Specify Minimum and Maximum Values for Block Parameters”.

Considerations for Other Modeling Goals

Goal Considerations and More Information
Apply storage type qualifiers const
and volatile

If you have Embedded Coder, to generate the storage type qualifiers, see
“Protect Global Data with const and volatile Type Qualifiers” on page 43-
13.

Prevent name clashes between
parameters in different components
by applying the keyword static

If you have Embedded Coder, use the storage class FileScope or a similar
storage class that you create. See “Choose Storage Class for Controlling
Data Representation in Generated Code” on page 34-74.

Generate ASAP2 (a2l) description You can generate an a2l file that uses the ASAP2 standard to describe
your calibration parameters. For more information, see “Define ASAP2
Information for Parameters and Signals” on page 61-3.

Generate AUTOSAR XML (ARXML)
description

If you have Embedded Coder, you can generate an ARXML file that
describes calibration parameters used by models that you configure for the
AUTOSAR standard. See “Model AUTOSAR Calibration Parameters and
Lookup Tables” (AUTOSAR Blockset).

Store lookup table data for
calibration

To store lookup table data for calibration according to the ASAP2 or
AUTOSAR standards (for example, STD_AXIS, COM_AXIS, or CURVE), you
can use Simulink.LookupTable and Simulink.Breakpoint objects in
lookup table blocks.

However, some limitations apply. See Simulink.LookupTable. To work
around the limitations of Simulink.LookupTable and
Simulink.Breakpoint objects, use Simulink.Parameter objects
instead.

For more information, see “Define ASAP2 Information for Parameters and
Signals” on page 61-3 and “Configure Lookup Tables for AUTOSAR
Measurement and Calibration” (AUTOSAR Blockset).

Use pragmas to store parameter
data in specific memory locations

If you have an Embedded Coder license, to generate code that includes
custom pragmas, use storage classes and memory sections. See “Control
Data and Function Placement in Memory by Inserting Pragmas” on page
43-2.

See Also
Simulink.Breakpoint | Simulink.LookupTable | Simulink.Parameter

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
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• “Reuse Parameter Data in Different Data Type Contexts” on page 34-141
• “Limitations for Block Parameter Tunability in Generated Code”
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “C Code Generation Configuration for Model Interface Elements”
• “Access Structured Data Through a Pointer That External Code Defines” on page 38-10
• “Configure Lookup Tables for AUTOSAR Measurement and Calibration” (AUTOSAR Blockset)
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Limitations for Block Parameter Tunability in Generated Code
A block parameter, MATLAB variable, or Simulink.Parameter object is tunable if it appears in the
generated code as data stored in memory, such as a global variable. For example, when you apply the
storage class ExportedGlobal to a parameter object, the parameter object appears tunable in the
generated code. When you set Default parameter behavior to Tunable, MATLAB variables and
parameter objects appear tunable in the generated code. By definition, model arguments also appear
tunable.

Under certain conditions, the code generator cannot maintain tunability of a parameter, variable,
object, or expression. In this case, the code generator inlines the numeric value, preventing you from
changing the value during code execution.

To detect these conditions in your model, set the model configuration parameter Detect loss of
tunability (see “Detect loss of tunability”) to warning or error.

Tunable Expression Limitations
You can specify block parameter values as expressions that use Simulink.Parameter objects or
workspace variables. For example, you can use the expression 5 * gainParam. For general
information about using expressions to set block parameter values, see “Use Mathematical
Expressions, MATLAB Functions, and Custom Functions”. For limitations with respect to expressions
that you use to set the values of Simulink.Parameter objects, see “Code Generation of Parameter
Objects With Expression Values”.

A tunable workspace variable is a Simulink.Parameter object or workspace variable that appears
tunable in the generated code. For example, an object or variable is tunable if you apply a storage
class other than Auto or if you set Default parameter behavior to Tunable.

An expression that contains one or more tunable workspace variables, model arguments, or tunable
mask parameters is called a tunable expression. The expression is tunable because the code
generator attempts to preserve the expression in the code. Because the code generator preserves the
expression, you can change the values of the parameter data during code execution.

The code generator reduces certain expressions to an inlined numeric value in the generated code.
The inlining renders workspace variables in the expression nontunable. To avoid loss of tunability due
to unsupported expressions, observe these guidelines:

• Expressions involving complex (i) workspace variables or parameter objects are not supported.
• Certain operators and functions cause the code generator to reduce expressions and remove

tunability. To determine whether an operator or function causes loss of tunability, use the
information in this table.

Category Operators or Functions
1 + - .* ./ < > <= >= == ~= & |
2 * /
3 abs, acos, asin, atan, atan2, boolean, ceil, cos, cosh, exp, floor,

log, log10, sign, sin, sinh, sqrt, tan, tanh, single, int8, int16,
int32, uint8, uint16, uint32

4 : .^ ^ [] {} . \ .\ ' .' , ;
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• Use operators from category 1 without loss of tunability.
• Use operators from category 2 in expressions as long as at least one operand is a scalar. For

example, scalar/scalar and scalar/matrix operand combinations are supported, but matrix/
matrix combinations are not supported.

• You can use tunable workspace variables as arguments for the functions in category 3. If you
use other functions, the code generator removes the tunability of the arguments.

• The operators in category 4 are not supported.
• The Fcn and If blocks do not support tunable expressions for code generation or in referenced

models.
• You can write mask initialization code that creates and modifies variables. If you use those

variables in an expression, the expression is not tunable.
• You can specify a data type for the Simulink.Parameter objects or workspace variables that

make up expressions. As long as the data type of these variables and objects and the data type of
the corresponding block parameters are the same or double, the code generator can preserve
tunability.

If the code generator preserves tunability of a parameter expression that includes at least one
element of an integer type, simulation and execution of generated code can produce results that are
numerically inconsistent. Evaluation of the expression in the generated code results in an overflow
while the expression saturates during simulation. For more information, see “Numerical Consistency
of Model and Generated Code Simulation Results”.

Linear Block Parameter Tunability
These blocks have a Realization parameter that affects the tunability of their numeric parameters:

• Transfer Fcn
• State-Space
• Discrete State-Space

To set the Realization parameter, you must use the command prompt:

set_param(gcb,'Realization','auto')

For the Realization parameter, you can choose these options:

• general: The block's numeric parameters appear tunable in the generated code.
• sparse: The generated code represents the block’s parameters as transformed values that

increase efficiency. The parameters are not tunable.
• auto: The default. If one or more of the block’s parameters are tunable (for example, because you

use a tunable parameter object to set a parameter value), then the block uses the general
realization. Otherwise, the block uses the sparse realization.

To tune the parameter values of one of these blocks during an external mode simulation, the block
must use the general realization.

Parameter Structures
As described in “Organize Data into Structures in Generated Code” on page 34-145, you can create
structures of parameter data in the generated code.
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• If a parameter structure is tunable, the numeric fields of the structure are tunable in the
generated code. However, if a field contains a nontunable entity, such as a multidimensional array,
the structure fields are not tunable.

• You cannot declare individual substructures or fields within a parameter structure as tunable. You
cannot use a Simulink.Parameter object as the value of a structure field. Instead, you must
store the entire structure in the parameter object.

See Also

Related Examples
• “Create Tunable Calibration Parameter in the Generated Code”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Code Generation of Parameter Objects With Expression Values
As described in “Set Variable Value by Using a Mathematical Expression”, you can set the value of a
Simulink.Parameter object to an expression involving other MATLAB variables or parameter
objects. When you generate code from a model that uses such a parameter object, to achieve your
goal, use the information in the table.

Goal Technique and More Information
Generate code without Embedded Coder. For the parameter object that uses the

expression, apply an available storage class (see
“C Code Generation Configuration for Model
Interface Elements”).

For the parameter objects used in the expression,
apply only the storage class Auto.

Generate code that defines a global variable and
initializes it by using an expression involving
system constants and other macros (requires
Embedded Coder).

See “Initialize Parameter Value From System
Constant or Other Macro (Embedded Coder)” on
page 34-116.

Generate code that defines a macro whose value
is an expression involving other macros (requires
Embedded Coder).

For the parameter object that uses the
expression, apply a storage class that yields a
macro in the generated code, such as Define
(see “Macro Definitions (#define)” on page 25-
54).

For the parameter objects used in the expression,
apply storage classes that yield imported macros.
For example, use the storage class
ImportedDefine. Your external code must
define these macros.

Considerations and Limitations
• To avoid errors that prevent code generation, if you apply a storage class other than Auto to the

dependent parameter object (which uses the expression as its value), the parameter objects used
in the expression must use either Auto or a storage class that yields a macro in the generated
code.

• You cannot set the value of a parameter object that represents a symbolic dimension (see
“Implement Dimension Variants for Array Sizes in Generated Code” on page 26-2) to an
expression.

• With Embedded Coder, you can generate code that preserves the expression, but only for the
purpose of statically initializing the value of a global variable or macro that corresponds to the
dependent parameter object. Follow the guidelines in “Expression Preservation”.

Expression Preservation
If you want Embedded Coder to preserve expressions in the generated code, adhere to these
restrictions and guidelines.
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• The dependent parameter object must use a storage class other than Auto. For example, to
generate a global variable and initialize it by using the expression, use ExportedGlobal or
ExportToFile.

• The parameter objects used in the expression must:

• Use a storage class that yields a macro in the generated code, such as Define.
• Have scalar, real values if the expression uses operators.

• The expression can use only these operators (in MATLAB syntax):

• Mathematical: +, -, *
• Relational: ==, ~=, <, >, <=, >=

• These data typing guidelines apply:

• If possible, for a parameter object used in an expression, leave the DataType property at the
default value, auto.

To use a value other than auto, you must set the DataType property of the object that uses
the expression to the same value. Otherwise, the code generator does not preserve the
expression.

• If you want to use a parameter object in multiple different expressions, and the dependent
parameter objects have different data types, leave the DataType property of the independent
object at the default value, auto. In the generated code, the value of the macro is expressed as
a floating-point number (with effective data type double), and the code initializes the
dependent parameters by typecasting the result of each expression.

See Also
Simulink.Parameter

Related Examples
• “Create Tunable Calibration Parameter in the Generated Code”
• “Share and Reuse Block Parameter Values by Creating Variables”
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Configure Packaging of Parameter Arguments in Generated
Code

When you create a reusable component as a referenced model, configure block parameters to use the
same value for instances of the component or a different value for each instance.

To customize the implementation of parameter arguments in the generated code, you can configure
the packaging of these parameters in the model where they are defined.

Configure the default mapping for model parameter arguments by using one of these storage classes:

• Default — Each instance of the parameter is allocated a piece of memory in an exported
structure whose attributes are defined by identifier naming rules.

• A structured storage class — Each instance of the parameter is allocated a piece of memory as
defined by the code definition of that storage class.

Individually specify the storage class for model parameter arguments by using one of these storage
classes:

• Auto — The parameter appears as an individual model function argument in the generated code.
If a block in the model does not reference the parameter, it can be optimized away by the code
generator.

• Model default — Each instance of the parameter is allocated a piece of memory as defined by
the code definition of the default storage class. Specify this default storage class through the
model default mapping.

If you use edit-time checking for code generation, you get an error for an invalid storage class.

For a parameter argument with a non-Auto storage class:

• On the Model block, you can specify the per-instance value as either a literal, a numeric MATLAB
variable, or a Simulink.Parameter object.

• If the per-instance value is a Simulink.Parameter object, the object must have storage class
Auto.

• If the per-instance value is a value expression, the evaluated value of the expression is used to
statically initialize the parameter.

If you do not specify a default or individual storage class for a parameter argument, the code
generator applies an internal storage class, InstP, to the parameter. The Instp storage class has
these properties:

• Exported scope
• Type naming rule is $R_InstP$M
• Instance name is InstP$R$M

Code Generation Behavior
For single-instance referenced models, the parameter arguments reside in a standalone global
structure. The top model defines the structure. The referenced model declares and uses the
structure.
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For multi-instance referenced models, the parameter arguments are part of a hierarchically nested
structure that the top model declares and defines. The referenced model has access to its parameter
values through a pointer in its self structure. The self structure points to a substructure of the
structure that the top model defines.

For parameter arguments defined in the top model, if the argument does not have a storage class, it
is inlined. If it has a storage class, the resulting code depends on the value of the Code interface
packaging parameter:

• Nonreusable function — The parameter is generated in a structure defined in the top model.
• Reusable function — The parameter is generated in a structure passed as part of the first

argument of the function.

To understand the behavior of instance-specific parameters in the generated code, consider this
referenced model that defines two parameter arguments, gainArg and coeffArg.

First consider the case where this model is configured to support only a single instance and the
default mapping for model parameter arguments does not have a storage class. In the
ex_arg_code_ref.h file, there is a type definition and a declaration for the instance-specific
parameters.
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When the top model references this model and supplies values for the instance-specific parameters,
the code for the top model defines the instance-specific parameters by using the values provided by
the top model.

Now consider if the referenced model is configured to support multiple instances.
ex_arg_code_ref.h contains the same type definition as the single-instance, but the self for the
model also contains a pointer to an instance of that data structure. There is no pointer declaration to
a standalone global variable of that structure.

The top model declares a parent structure, including an instance of this substructure, and initializes
the pointer in the self structure for the referenced model.
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Limitations
When you configure an instance-specific parameter for code generation, these limitations apply:

• The default mapping for model parameter arguments cannot be reused for model parameters or
external parameter objects.

• Instance-specific parameter values must be finite.
• Parameter arguments with a non-Auto storage class are not supported for C++ code generation

with a C++ class code interface.

See Also

Related Examples
• “Generate Code for Model Reference Hierarchy”
• “Parameterize Instances of a Reusable Referenced Model”
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Parameter Data Types in the Generated Code
The data type of a block parameter (such as the Gain parameter of a Gain block), numeric MATLAB
variable, or Simulink.Parameter object determines the data type that the corresponding entity in
the generated code uses (for example, a global variable or an argument of a function). To generate
more efficient code, you can match parameter data types with signal data types or store parameters
in smaller data types.

For basic information about setting block parameter data types in a model, see “Control Block
Parameter Data Types”.

Significance of Parameter Data Types
The data type that a block parameter, MATLAB variable, or parameter object uses determines the
data type that the generated code uses to store the parameter value in memory. For example:

• If you set the model configuration parameter Default parameter behavior (see “Default
parameter behavior”) to Tunable, the Gain parameter of a Gain block appears in the generated
code as a field of a global structure that stores parameter data. If you apply the data type single
to the block parameter in the model, the structure field in the code uses the corresponding data
type, real32_T.

• If you apply the storage class ExportedGlobal to a Simulink.Parameter object, the object
appears in the generated code as a separate global variable. If you set the DataType property of
the object to int8, the global variable in the code uses the corresponding data type, int8_T.

• If you configure a Simulink.Parameter object in a model workspace as a model argument, the
object appears in the generated code as a formal parameter (argument) of a model entry-point
function, such as the step function. The DataType property of the object determines the data
type of the formal parameter.

Other than determining the data type that the generated code uses to store parameter values in
memory, the data type of a parameter, variable, or object can also:

• Cause the block to cast the value of the parameter prior to code generation. The cast can result in
overflow, underflow, or quantization.

• Cause the generated code to include extra code, for example saturation code.

Typecasts Due to Parameter Data Type Mismatches
When the data types of block parameters, workspace variables, and signals differ, blocks can use
typecasts to reconcile the data type mismatches. These typecasts can cause the generated code
algorithm, including the model step function, to include explicit casts to reconcile mismatches in
storage data type and C bit shifts to reconcile mismatches in fixed-point scaling.

Parameter data type mismatches can occur when:

• The data type that you specify for a MATLAB variable or parameter object
(Simulink.Parameter) differs from the data type of a block parameter. The block parameter
typecasts the value of the variable or object.

• The data type that you specify for an initial value differs from the data type of the initialized signal
or state.
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• The data type that you specify for a block parameter differs from the data type of the signal or
signals that the parameter operates on. Some blocks typecast the parameter to perform the
operation. For example, the Gain block performs this typecast.

If you configure a variable or object to use bias or fractional fixed-point slope, the block parameter
cannot perform the typecast. In this case, you must match the data type of the variable or parameter
object with the data type of the block parameter. Use one of these techniques:

• Use context-sensitive data typing for the variable or parameter object. For a MATLAB variable,
use a double number to set the value of the variable. For a parameter object, set the DataType
property to auto.

• Use a Simulink.AliasType or Simulink.NumericType object to set the data type of the block
parameter and the data type of a parameter object.

Use this technique when you cannot rely on context-sensitive data typing, for example, when you
use the field of a structure to set the value of the block parameter.

• Manually specify the same data type for the block parameter and the variable or parameter object.

Use this technique to reduce the dependence of the model on inherited and context-sensitive data
types and on external variables and objects.

For blocks that access parameter data through pointer or reference in the generated code, if you
specify different data types for the workspace variable and the block parameter, the generated code
implicitly casts the data type of the variable to the data type of the block parameter. Note, that an
implicit cast requires a data copy which could significantly increase RAM consumption and slow down
code execution speed for large data sets. For example, Lookup Table blocks often access large vectors
or matrices through pointer or reference in the generated code.

For information about matching parameter data types when you use model arguments, see “Control
Data Types of Model Arguments and Argument Values” on page 5-50.

Detect Downcast and Loss of Precision due to Data Type Mismatches

You can configure diagnostic configuration parameters to detect unintentional data type mismatches
that result in quantization and loss of parameter precision. See “Model Configuration Parameters:
Data Validity Diagnostics”.

Considerations for Other Modeling Patterns
When you use specific modeling patterns and constructs such as fixed-point data types, parameter
structures, and lookup table objects, use different techniques to control parameter data types.

• “Tunable Parameters and Best-Precision Fixed-Point Scaling” on page 34-130
• “Control Data Types of Structure Fields” on page 34-131
• “Control Data Types of Lookup Table Objects” on page 34-131
• “Data Typing for Expressions in Parameter Objects” on page 34-132

Tunable Parameters and Best-Precision Fixed-Point Scaling

To apply best-precision fixed-point scaling to a tunable block parameter or parameter object, you can
use the Fixed-Point Tool to autoscale an entire system or use the Data Type Assistant to configure
individual parameters or objects. See “Calculate Best-Precision Fixed-Point Scaling for Tunable Block
Parameters”.

34 Data Representation in Simulink Coder

34-130



If a tunable parameter uses best-precision fixed-point scaling, Simulink chooses a data type based on
the minimum and maximum values that you specify for the parameter (see “Specify Minimum and
Maximum Values for Block Parameters”). You can specify these values in the block dialog box that
uses the parameter or in the properties of a Simulink.Parameter object.

If you do not specify a minimum or maximum, Simulink chooses a data type based on the value of the
parameter. The chosen scaling might restrict the range of possible tuning values. Therefore, it is a
best practice to specify minimum and maximum values for each tunable parameter.

A tunable parameter can use best-precision scaling even if you do not specify it in the parameter data
type. For example, the Gain block can choose a best-precision scaling if the Parameter data type in
the block dialog box is set to Inherit: Inherit via internal rule. This setting is the default
for the block.

Control Data Types of Structure Fields

When you use a structure as the value of a block parameter (for example to initialize a bus signal), or
when you organize multiple block parameter values into a single structure, you can create a
Simulink.Bus object to use as the data type of a Simulink.Parameter object. You can then
control the data types of individual fields in the structure. See “Control Field Data Types and
Characteristics by Creating Parameter Object” and “Control Data Types of Initial Condition Structure
Fields”.

Control Data Types of Lookup Table Objects

When you use Simulink.LookupTable and Simulink.Breakpoint objects to store table and
breakpoint data for a lookup table block, to control the data types of the table and breakpoint data,
use one of these techniques:

• Set the Value property of the embedded Simulink.lookuptable.Table and
Simulink.lookuptable.Breakpoint objects by using untyped expressions such as [1 2 3],
which returns a double vector. If Breakpoint specification is set to Explicit values, use the
MATLAB expression text box and tabular interface at the bottom of the property dialog box. To
control the data type, set the DataType property to a value other than auto.

Use this technique to separate the value of the table or breakpoint data from the data type, which
can improve readability and understanding of your design. You can then use a
Simulink.NumericType or Simulink.AliasType object to:

• Customize the name of the data type in the generated code.
• Match the data type of the table or breakpoint data with the data type of a signal in the model.

• Set the Value property of the embedded objects by using typed expressions such as single([1
2 3]). To use a fixed-point data type, set the Value property with an fi object. If Breakpoint
specification is set to Explicit values, use the MATLAB expression text box and tabular
interface at the bottom of the property dialog box.

Set the DataType property of the embedded objects to the default value, auto. The table and
breakpoint data then acquire the data type that you use to set the Value property.

Use this technique to store the data type information in the Value property, which can simplify
the way you interact with the Simulink.LookupTable and Simulink.Breakpoint objects. You
can leave the DataType property at the default value.

When you later change the breakpoint or table data in the Value property, preserve the data type
information by using a typed expression. Alternatively, if you use a command at the command
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prompt or a script to change the data, to avoid using a typed expression, use subscripted
assignment, (:).

myLUTObject.Table.Value(:) = [4 5 6];

When you change the data stored in the Value property, if you do not use a typed expression or
subscripted assignment, you lose the data type information.

When blocks in a subsystem use Simulink.LookupTable or Simulink.Breakpoint objects, you
cannot set data type override (see “Control Fixed-Point Instrumentation and Data Type Override”)
only on the subsystem. Instead, set data type override on the entire model.

Data Typing for Expressions in Parameter Objects

You can use an expression to set the value of a parameter object (such as Simulink.Parameter).
The expression encodes mathematical relationships between different objects. When you use this
technique, different data typing rules apply. See “Set Variable Value by Using a Mathematical
Expression”.

See Also

Related Examples
• “Generate Efficient Code by Specifying Data Types for Block Parameters” on page 34-133
• “Reuse Parameter Data in Different Data Type Contexts” on page 34-141
• “Data Types Supported by Simulink”
• “Control Signal Data Types”
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Generate Efficient Code by Specifying Data Types for Block
Parameters

To generate more efficient code, match the data types of block parameters (such as the Gain
parameter of a Gain block) with signal data types. Alternatively, you can store parameters in smaller
data types.

Eliminate Unnecessary Typecasts and Shifts by Matching Data Types
These examples show how to generate efficient code by configuring a block parameter to use the
same data type as a signal that the block operates on.

Store Data Type Information in Model

Open the example model rtwdemo_configrpinterface and configure it to show the generated names of
blocks.

open_system('rtwdemo_configrpinterface')
set_param('rtwdemo_configrpinterface','HideAutomaticNames','off')

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, select the Parameters tab.

In the model, select the Gain block. In the Model Data Editor, the Data Type column shows that the
data type of the Gain parameter of the block is set to Inherit: Same as input. With this setting,
the Gain parameter of this block uses the same data type as the input signal.

In the Code Mappings editor, under Parameters, set the storage class for K1 to ExportedGlobal.

In the Model Data Editor, set Change view to Design.

In the data table, for the row that represents K1, in the Data Type column, select Auto. With this
setting, the parameter object acquires its data type from the block parameters that use the object (in
this case, the Gain block parameter).

Alternatively, to create and configure the object, use these commands at the command prompt:

cm = coder.mapping.api.get('rtwdemo_configrpinterface');
setModelParameter(cm,'K1','StorageClass','ExportedGlobal');
hws = get_param(bdroot, 'modelworkspace');
hws.setVariablePart('K1.DataType','Auto');

Generate code from the model.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of code generation for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action          Rebuild Reason                                    
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=============================================================================================
rtwdemo_configrpinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.243s

The generated file rtwdemo_configrpinterface.c defines the global variable K1 by using the data type
real_T.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* Exported block parameters */','real_T K1 = 2.0;',1,1)

/* Exported block parameters */
real_T K1 = 2.0;                       /* Variable: K1

The generated code algorithm in the model step function uses K1 directly without typecasting.

rtwdemodbtype(file,'output =',...
    '10U',1,1)

    output = K1 * look1_binlc((*input2), rtCP_Table1_bp01Data,
      rtCP_Table1_tableData, 10U);

In the Code Mappings editor, under Parameters, you can optionally set the storage class for K1 to
Inherit: Inherit via internal rule (the default).

In this case, the block parameter chooses the same data type as the input signal, double. However,
when you use Inherit: Inherit via internal rule, under other circumstances (for example,
when you use fixed-point data types), the block parameter might choose a different data type.

Store Data Type Information in Parameter Object

When you use a Simulink.Parameter object to export or import parameter data from the
generated code to your external code, for example by applying the storage class ImportedExtern,
you can specify data type information in the parameter object. To match the data type of the
parameter object with a signal data type, create a Simulink.NumericType or
Simulink.AliasType object. You can strictly control the data type that the parameter object uses
in the generated code, eliminating the risk that Simulink chooses a different data type when you
make changes to the model.

At the command prompt, create a Simulink.NumericType object that represents the data type
double.

myType = Simulink.NumericType;
myType.DataTypeMode = 'Double';

Use the Model Data Editor Data Type column to set these data types to myType:

• The parameter object. Use the Parameters tab.
• The Inport block named In2. Use the Inports/Outports tab. Due to data type propagation, the

input signal of the Gain block also uses myType.

Use the Model Data Editor Parameters tab to set the data type of the Gain block parameter to
Inherit: Inherit from 'Gain'.

Use this data type object as the data type of the parameter object.
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Alternatively, to configure the object and the blocks, use these commands at the command prompt:

K1.DataType = 'myType';
set_param('rtwdemo_configrpinterface/In2','OutDataTypeStr','myType')
set_param('rtwdemo_configrpinterface/Gain','ParamDataTypeStr','Inherit: Inherit from ''Gain''')

Generate code from the model.

slbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of code generation for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action          Rebuild Reason                   
============================================================================
rtwdemo_configrpinterface  Code generated  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.436s

The global variable K1 continues to use the data type real_T.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* Exported block parameters */','real_T K1 = 2.0;',1,1)

/* Exported block parameters */
real_T K1 = 2.0;                       /* Variable: K1

Close the code generation report.

rtwdemoclean;

Reduce Memory Consumption by Storing Parameter Value in Small
Data Type
When you use a parameter object (for example, Simulink.Parameter) to set block parameter
values, you can configure the object to appear in the generated code as a tunable global variable. By
default, the parameter object and the corresponding global variable typically uses the same data type
as the signal or signals on which the block operates. For example, if the input signal of a Gain block
uses the data type int16, the parameter object typically use the same data type. To reduce the
amount of memory that this variable consumes, specify that the variable use a smaller integer data
type such as int8.

Store Parameter Value in Integer Data Type

Open the model rtwdemo_configrpinterface and set the properties of the model.

open_system('rtwdemo_configrpinterface')
set_param('rtwdemo_configrpinterface','HideAutomaticNames','off')
set_param('rtwdemo_configrpinterface','ShowPortDataTypes','on')
set_param('rtwdemo_configrpinterface','SimulationCommand','Update')
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Many of the signals in the model use the data type double.

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, inspect the Parameters tab.

Click the Show/refresh additional information button.

Next to the Filter contents box, activate the Filter using selection button.

In the model, click the Gain block. The Model Data Editor shows one row that corresponds to the
Gain parameter of the block and one row that corresponds to the MATLAB variable K1, which sets
the parameter value to 2. K1 resides in the model workspace.

In the C Code tab, select Code Interface > Default Code Mappings. In the Code Mappings editor,
under Parameters, set the storage class for K1 to ExportedGlobal.

cm = coder.mapping.api.get('rtwdemo_configrpinterface');
setModelParameter(cm,'K1','StorageClass','ExportedGlobal');

In the C Code tab, select Code Interface > Default Code Mappings. In the Model Data Editor, set
Change view to Design and ensure that the Data Type column for K1 is int8.

hws = get_param(bdroot, 'modelworkspace');
hws.setVariablePart('K1.DataType','int8');
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For the row that represents the Gain block parameter, in the Data Type column, set the drop-down
list to Inherit: Inherit from 'Gain'. With this setting, the Gain parameter of the block
inherits the int8 data type from the parameter object.

set_param('rtwdemo_configrpinterface/Gain','ParamDataTypeStr',...
    'Inherit: Inherit from ''Gain''')

Generate code from the model.

rtwbuild('rtwdemo_configrpinterface')

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of code generation for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action          Rebuild Reason                                    
=============================================================================================
rtwdemo_configrpinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.182s

The generated file rtwdemo_configrpinterface.c defines the global variable K1 by using the
data type int8_T, which corresponds to the data type int8 in Simulink.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* Exported block parameters */','int8_T K1 = 2;',1,1)

/* Exported block parameters */
int8_T K1 = 2;                         /* Variable: K1

The code algorithm in the model step function uses K1 to calculate the output of the Gain block. The
algorithm casts K1 to the data type real_T (double) because the signals involved in the calculation
use the data type real_T.

rtwdemodbtype(file,'output =',...
    '10U',1,1)

    output = (real_T)K1 * look1_binlc((*input2), rtCP_Table1_bp01Data,
      rtCP_Table1_tableData, 10U);

Store Fixed-Point Parameter Value in Smaller Integer Data Type

Suppose you configure the signals in your model to use fixed-point data types. You want a gain
parameter to appear in the generated code as a tunable global variable. You know the range of real-
world values that you expect the parameter to assume (for example, between 0 and 4). If you can
meet your application requirements despite reduced precision, you can reduce memory consumption
by configuring the parameter to use a different data type than the input and output signals of the
block.

Open the example model fxpdemo_direct_form2 and configure it to show the generated names of
blocks.

 Generate Efficient Code by Specifying Data Types for Block Parameters

34-137



load_system('fxpdemo_direct_form2')
set_param('fxpdemo_direct_form2','HideAutomaticNames','off')
open_system('fxpdemo_direct_form2')

Update the block diagram. Signals in this model use signed fixed-point data types with a word length
of 16 and binary-point-only scaling.

Open the Gain5 block dialog box. The Gain parameter is set to 1.85. Suppose you want to configure
this parameter.

Set Gain to myGainParam and click Apply.

Click the action button (with three vertical dots) next to the parameter value. Select Create.

In the Create New Data dialog box, set Value to Simulink.Parameter(1.85) and click Create.
The Simulink.Parameter object myGainParam appears in the base workspace.

Open the Simulink Coder app. In the C Code tab, select Code Interface > Default Code
Mappings. In the Code Mappings editor, under Parameters, set the storage class for myGainParam
to ExportedGlobal. With this setting, myGainParam appears in the generated code as a global
variable.

In the block dialog box, on the Parameter Attributes tab, set Parameter minimum to 0 and
Parameter maximum to 4.

Set Parameter data type to fixdt(0,8) and click Apply.
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Click the Show Data Type Assistant button. The Data Type Assistant shows that the expression
fixdt(0,8) specifies an unsigned fixed-point data type with a word length of 8 and best-precision
scaling. When you simulate or generate code, the block parameter chooses a fraction length (scaling)
that enables the data type to represent values between the parameter minimum and maximum (0 and
4) with the best possible precision.

In the Data Type Assistant, set Scaling to Binary point. Click Calculate Best-Precision Scaling,
Fixed-point details, and Refresh Details. The information under Fixed-point details shows that a
fraction length of 5 can represent the parameter values with a precision of 0.03125.

Set Scaling back to Best precision and click OK. In this example, when you simulate or generate
code, the block parameter chooses a fraction length of 5.

Alternatively, you can use these commands at the command prompt to create the object and configure
the block:

myGainParam = Simulink.Parameter(1.85);
myGainParam.CoderInfo.StorageClass = 'ExportedGlobal';
set_param('fxpdemo_direct_form2/Gain5','Gain','myGainParam')
set_param('fxpdemo_direct_form2/Gain5','ParamMin','0','ParamMax','4')
set_param('fxpdemo_direct_form2/Gain5','ParamDataTypeStr','fixdt(0,8)')

Configure the model to produce a code generation report. To reduce clutter in the Command Window,
clear the configuration parameter Verbose build.

set_param('fxpdemo_direct_form2','GenerateReport','on',...
    'LaunchReport','on','RTWVerbose','off')

Generate code from the model.

evalc('rtwbuild(''fxpdemo_direct_form2'')');

The generated file fxpdemo_direct_form2.c defines the global variable myGainParam by using
the data type uint8_T, which corresponds to the specified word length, 8. The code initializes the
variable by using an integer value that, given the fraction length of 5, represents the real-world
parameter value 1.85.

file = fullfile('fxpdemo_direct_form2_grt_rtw','fxpdemo_direct_form2.c');
rtwdemodbtype(file,'/* Exported block parameters */','uint8_T myGainParam = 59U;',1,1)

/* Exported block parameters */
uint8_T myGainParam = 59U;             /* Variable: myGainParam

The code algorithm uses myGainParam to calculate the output of the Gain5 block. The algorithm uses
a C shift to scale the result of the calculation.

rtwdemodbtype(file,'/* Gain: ''<Root>/Gain5'' incorporates:',...
'/* Gain: ''<Root>/Gain'' incorporates:',1,0)

  /* Gain: '<Root>/Gain5' incorporates:
   *  UnitDelay: '<Root>/Unit Delay1'
   */
  fxpdemo_direct_form2_B.Gain5 = (int16_T)((myGainParam *
    fxpdemo_direct_form2_B.UnitDelay1) >> 5);
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rtwdemoclean;

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Parameter Data Types in the Generated Code” on page 34-129
• “Reuse Parameter Data in Different Data Type Contexts” on page 34-141
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Reuse Parameter Data in Different Data Type Contexts
When you use a Simulink.Parameter object or a numeric MATLAB variable to set two or more
block parameter values, if the block parameters have different data types, you must explicitly specify
the data type of the object or variable. For example, you cannot leave the data type of the parameter
object at the default value, auto.

Create and Configure Example Model

Create the model ex_paramdt_contexts.

ex_paramdt_contexts

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, on the Inports/Outports tab, use the Data Type column to set the data
type of the In1 Inport block to single and the data type of the In2 block to int8.

On the Signals tab, set the data types of the Gain block outputs to Inherit: Same as input.

On the Parameters tab, for the Gain parameters of the Gain blocks, set Data Type to Inherit:
Same as input.

For the Gain parameters, set Value to myGainParam.

Alternatively, to configure the blocks, use these commands at the command prompt:

set_param('ex_paramdt_contexts/In1','OutDataTypeStr','single')
set_param('ex_paramdt_contexts/In2','OutDataTypeStr','int8')
set_param('ex_paramdt_contexts/Gain - single','Gain','myGainParam',...
    'OutDataTypeStr','Inherit: Same as input',...
    'ParamDataTypeStr','Inherit: Same as input')
set_param('ex_paramdt_contexts/Gain - int8','Gain','myGainParam',...
    'OutDataTypeStr','Inherit: Same as input',...
    'ParamDataTypeStr','Inherit: Same as input')

In the Model Data Editor, for either Gain block parameter, click the cell in the Value column. Next to
myGainParam, click the action button (with three vertical dots) and select Create.
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In the Create New Data dialog box, set Value to Simulink.Parameter(3) and click Create. A
Simulink.Parameter object with value 3 appears in the model workspace.

In the myGainParam property dialog box, set Data type to int8.

On the Code Generation tab, click Configure in Coder App.

In the Code Mappings editor, set the storage class of myGainParam to ExportedGlobal. With the
storage class ExportedGlobal, the object appears in the generated code as a global variable.

Alternatively, to create and configure the parameter object, use these commands at the command
prompt:

mws = get_param('ex_paramdt_contexts', 'modelworkspace');
mws.assignin('myGainParam',Simulink.Parameter(3));
setVariablePart(mws,'myGainParam.DataType','int8');
cm = coder.mapping.utils.create('ex_paramdt_contexts');
setModelParameter(cm,'myGainParam','StorageClass','ExportedGlobal');

In this model, you use the parameter object myGainParam to set two block parameter values. The
block parameters inherit different data types from the block input signals (single or int8). To use
myGainParam in these different data type contexts, you explicitly specify the data type of the
parameter object by setting the DataType property to int8.

Match Parameter Object Data Type with Signal Data Type

Optionally, use a Simulink.NumericType or Simulink.AliasType object to set the parameter
object data type and one of the signal data types. This technique eliminates unnecessary typecasts
and shifts in the generated code due to a mismatch between the parameter object data type and the
signal data type.

At the command prompt, create a Simulink.NumericType object to represent the data type int8.

sharedType_int8 = fixdt('int8');

In the Model Data Editor, on the Inports/Outports tab, set the data type of the In2 Inport block to
sharedType_int8.

On the Parameters tab, update the block diagram. The data table now contains a row that
represents the parameter object, myGainParam.

Use the Data Type column to set the data type of the parameter object to sharedType_int8.

Alternatively, to configure the block and the object, use these commands at the command prompt:

myGainParam.DataType = 'sharedType_int8';
set_param('ex_paramdt_contexts/In2','OutDataTypeStr','sharedType_int8')

The parameter object and the signal use the data type int8. To change this data type, adjust the
properties of the data type object sharedType_int8.

Generate and Inspect Code

Generate code from the model.

slbuild('ex_paramdt_contexts')
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### Starting build procedure for: ex_paramdt_contexts
### Successful completion of build procedure for: ex_paramdt_contexts

Build Summary

Top model targets built:

Model                Action                       Rebuild Reason                                    
====================================================================================================
ex_paramdt_contexts  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.03s

The generated file ex_paramdt_contexts.c defines the global variable myGainParam by using the
data type int8_T, which corresponds to the data type int8 in Simulink.

file = fullfile('ex_paramdt_contexts_grt_rtw','ex_paramdt_contexts.c');
rtwdemodbtype(file,'/* Exported block parameters */','int8_T myGainParam = 3;',1,1)

/* Exported block parameters */
int8_T myGainParam = 3;                /* Variable: myGainParam

The generated code algorithm in the model step function uses myGainParam to calculate the
outputs of the two Gain blocks. In the case of the Gain block whose input signal uses the data type
single, the code algorithm casts myGainParam to the data type real32_T, which corresponds to
the data type single in Simulink.

rtwdemodbtype(file,'/* Model step function */',...
    '/* Model initialize function */',1,0)

/* Model step function */
void ex_paramdt_contexts_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain - single'
   *  Inport: '<Root>/In1'
   */
  ex_paramdt_contexts_Y.Out1 = (real32_T)myGainParam * ex_paramdt_contexts_U.In1;

  /* Outport: '<Root>/Out2' incorporates:
   *  Gain: '<Root>/Gain - int8'
   *  Inport: '<Root>/In2'
   */
  ex_paramdt_contexts_Y.Out2 = (int8_T)(myGainParam * ex_paramdt_contexts_U.In2);
}

See Also

Related Examples
• “Parameter Data Types in the Generated Code” on page 34-129
• “Generate Efficient Code by Specifying Data Types for Block Parameters” on page 34-133
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• “Create Tunable Calibration Parameter in the Generated Code” on page 34-109
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Organize Data into Structures in Generated Code
In C code, you use structures (struct) to store data in contiguous locations in memory. You can
organize data, such as signals and states, by using meaningful names. Each structure acts as a
namespace, so you can reuse a name to designate multiple data items. Like arrays, with structures,
you can write code that efficiently transfers and operates on large amounts of data by using pointers.

By default, the code generator aggregates data into standard structures (see “How Generated Code
Stores Internal Signal, State, and Parameter Data” on page 34-49). To control the characteristics of
these structures or to override this default behavior by creating different structures, use the
information in the table.

Goal Technique
Control the characteristics of the standard data
structures. For example, specify the names of the
structure types, structure variables, and field
names.

With Embedded Coder, see “Control Data Type
Names in Generated Code” on page 36-2.

Control the placement of the structures in
memory, for example, by inserting pragmas or
other code decorations.

With Embedded Coder, see “Control Data and
Function Placement in Memory by Inserting
Pragmas” on page 43-2.
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Goal Technique
Aggregate data into structures whose names and
other basic characteristics you can control. As
you add blocks and signals to the model, the
resulting new data appears in these structures by
default.

With Embedded Coder, apply a structured storage
class to a category of data by using the Code
Mapping Editor.

• When you generate nonreetrant, single-
instance code by setting the model
configuration parameter Code interface
packaging to Nonreusable function,
create flat, global structure variables by
applying the built-in storage class Struct.
Alternatively, use example storage classes
created by Quick Start tool, ParamStruct
and SignalStruct, or create and apply your
own structured storage class.

• When you generate multi-instance (reentrant)
code from a model or a component, for
example by setting Code interface
packaging to a value other than
Nonreusable function, in the Code
Mappings editor, you cannot use the built-in
storage class Struct or a structured storage
class that you create in a package. Instead,
create your own structured storage class by
using an Embedded Coder Dictionary. If you
use the Embedded Coder Quick Start tool to
prepare the model for code generation (see
“Generate Code by Using the Quick Start
Tool” on page 51-9), you can use example
storage classes ParamStruct and
SignalStruct.

• You cannot use this technique to aggregate
global data stores or global parameters (which
include parameter objects that you store in
the base workspace or a data dictionary). For
these kinds of data, use other techniques to
create structures.

For more information about the Code Mapping
Editor, see “Configure Default C Code Generation
for Categories of Data Elements and Functions”
on page 33-15. To create your own storage class,
see “Define Storage Classes, Memory Sections,
and Function Templates for Software
Architecture” on page 31-2.
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Goal Technique
Improve readability of the generated code by
organizing individual data items into a custom
structure whose characteristics you can finely
control.

Create a Simulink.Bus object that represents
the structure type that you want. Use the bus
object to set the data types of nonvirtual bus
signals and parameter structures in your model.

• For an example that shows how to organize
parameter data, see “Structures of
Parameters” on page 34-150.

• For an example that shows how to organize
signal data, see “Structures of Signals” on
page 34-152.

To create an array of structures, see “Arrays of
Structures” on page 34-158.

Exchange structured data between generated
code and your external code, for example, when
the external code already defines a custom
structure type and a corresponding global
variable.

Create a Simulink.Bus object that represents
the structure type that you want. If your external
code already defines the type, use the
Simulink.importExternalCTypes function to
generate the bus object. Use the bus object to set
the data types of nonvirtual bus signals and
parameter structures in your model. For an
example, see “Exchange Structured and
Enumerated Data Between Generated and
External Code” on page 36-27.
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Goal Technique
Reduce the number of arguments (formal
parameters) for generated functions.

• To reduce the number of arguments for the
entry-point functions of the model from which
you generate code, such as model_step, see
“Reduce Number of Arguments by Using
Structures” on page 34-47.

• To reduce the number of arguments for the
entry-point functions of a referenced model, in
the referenced model:

• Configure root-level Inport and Outport
blocks to appear in the code as structure
fields. Replace multiple such blocks with a
single block that you configure as a
nonvirtual bus signal. With this technique,
you have the greatest control over the
structure characteristics. As you add
blocks to the model, you must manually
modify the bus definitions. See “Nonvirtual
Buses and Parameter Structures” on page
34-150.

• Organize model arguments into a custom
structure (see “Specify Instance-Specific
Parameter Values for Reusable Referenced
Model” on page 5-28).

• To reduce the number of arguments for the
entry-point functions of a masked, reentrant
subsystem, aggregate mask parameters into a
custom structure.

Organize lookup table data into a structure. Use Simulink.LookupTable and
Simulink.Breakpoint objects. See
Simulink.LookupTable.

Generate bit fields. See “Bitfields” on page 25-68 and “Optimize
Generated Code By Packing Boolean Data Into
Bitfields” on page 73-11.

Techniques to Create Structures
To create structures in the generated code, you can use these techniques:

• Apply a structured storage class to categories of data by using the Code Mapping Editor. As you
add blocks and signals to a model, new data elements acquire this storage class by default.

• Apply a structured storage class, such as the built-in storage class Struct, directly to individual
data items by using the Model Data Editor.

• Create custom nonvirtual buses and parameter structures.

To decide which techniques to use, use the information in the table.
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Capability Default Application of
Structured Storage
Class

Direct Application of
Structured Storage
Class

Nonvirtual Buses and
Parameter Structures

Aggregate new data
items into a structure
by default

Yes No No

Prevent elimination of
the target data by
optimizations (specify
that the data appear in
the generated code)

No Yes Only if you directly
apply a storage class
such as
ExportedGlobal to
the bus or structure

Aggregate data into a
structure without
changing the
appearance of the block
diagram

Yes Yes No

Place signal, state, and
parameter data in the
same structure

No Yes No

Include state data in a
structure

Yes Yes No

Organize structures into
nested structures

No No Yes

Organize structures into
an array of structures

No No Yes

Control name of
structure type

Yes Yes, but the type name
derives from the
variable name, which
you specify

Yes

Create a structure to
reduce the number of
arguments in a
generated function

Yes, but you must create
your own storage class
by using an Embedded
Coder Dictionary

No Yes

Requires Embedded
Coder

Yes Yes No

Default Application of Structured Storage Class
You can apply a default storage class to a category of model data. As you add blocks and signals to
the model, the associated data acquire the default storage class that you specify. To aggregate new
data into structures by default, you can apply structured storage classes. You must use example
storage classes ParamStruct and SignalStruct created by the Quick Start tool or create your own
storage class by using an Embedded Coder Dictionary.

You cannot use default application to aggregate global data stores or global parameters (parameter
objects that you store in the base workspace or a data dictionary).
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To apply default storage classes, use the Code Mapping Editor. In a model window, in the Apps
gallery, click Embedded Coder. Then, under Code Mappings > Data Defaults, apply storage
classes by using the Storage Class column.

For more information about the Code Mapping Editor, see “Configure Default C Code Generation for
Categories of Data Elements and Functions” on page 33-15. To create your own storage class by
using an Embedded Coder Dictionary, see “Create Code Definitions for Use in the Code Mappings
Editor” on page 31-2.

Direct Application of Structured Storage Class
You can apply a structured storage class to individual data items. The direct application prevents
code generation optimizations, such as Default parameter behavior and Signal storage reuse,
from eliminating each data item from the generated code. The direct application also overrides the
default storage classes that you specify with Code Mappings > Data Defaults.

To directly apply a storage class, use the Model Data Editor (on the Modeling tab, click Model Data
Editor). Set Change view to Code and apply the storage class by using the Storage Class column.

For an example that shows how to use Struct, see “Configure Parameters for C Code Generation” on
page 33-62. For more information about applying storage classes, see “Organize Parameter Data into
a Structure by Using Struct Storage Class” on page 33-68.

Nonvirtual Buses and Parameter Structures
• To create a nonvirtual bus signal, use a Bus Creator block to organize multiple signal lines into a

single bus, or configure an Inport block or Outport block as a nonvirtual bus. You must create a
Simulink.Bus object that represents the structure type. For an example, see “Structures of
Signals” on page 34-152. For general information about nonvirtual buses, see “Group Signal Lines
into Virtual Buses”.

• To create a parameter structure, use MATLAB commands or the Variable Editor to organize the
values of multiple block parameters into a MATLAB structure. Optionally, create a Simulink.Bus
object so that you can control the name of the structure type and other characteristics such as the
data type and dimensions of each field. For an example, see “Structures of Parameters” on page
34-150. For general information about parameter structures, see “Organize Related Block
Parameter Definitions in Structures”.

Structures of Parameters

Create a structure in the generated code. The structure stores parameter data.

C Construct

typedef struct {
  double G1;
  double G2;
} myStructType;

myStructType myStruct = {
  2.0,
  -2.0
} ; 
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Procedure

1. Open the example model rtwdemo_paraminline.

2. On the Modeling tab, click Model Data Editor. In the Model Data Editor, select the Parameters
tab.

3. In the model, click the Gain block labeled G1. In the Model Data Editor, use the Value column to
set the value of the Gain parameter to myStruct.G1.

4. Set the value of the Gain parameter in the G2 block to myStruct.G2.

5. Next to myStruct.G2, click the action button (with three vertical dots) and select Create.

6. In the Create New Data dialog box, set Value to Simulink.Parameter(struct) and click
Create. A Simulink.Parameter object named myStruct appears in the base workspace.

7. In the Simulink.Parameter property dialog box, next to the Value property, click the action button
and select Open Variable Editor.

8. Right-click the white space under the Field column and select New. Name the new structure field
G1. Use the Value column to set the value of the field to 2.

9. Add a field G2 whose value is -2, and then close the Variable Editor.

10. In the Simulink.Parameter property dialog box, on the Code Generation tab, set Storage class
to ExportedGlobal. The structure myStruct appears in the generated code as a global variable.

11. Generate code from the model.

Results

The generated header file rtwdemo_paraminline_types.h defines a structure type that has a
random name.
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typedef struct {
  real_T G1;
  real_T G2;
} struct_6h72eH5WFuEIyQr5YrdGuB;

The source file rtwdemo_paraminline.c defines and initializes the structure variable myStruct.

/* Exported block parameters */
struct_6h72eH5WFuEIyQr5YrdGuB myStruct = {
  2.0,
  -2.0
} ;                                    /* Variable: myStruct
                                        * Referenced by:
                                        *   '<Root>/G1'
                                        *   '<Root>/G2'
                                        */

Specify Name of Structure Type

1. Optionally, specify a name to use for the structure type definition (struct). At the command
prompt, use the function Simulink.Bus.createObject to create a Simulink.Bus object that
represents the structure type.

2. The default name of the object is slBus1. Change the name by copying the object into a new
MATLAB variable.

3. In the Model Data Editor, click the Show/refresh additional information button.

4. In the data table, find the row that corresponds to myStruct. Use the Data Type column to set the
data type of myStruct to Bus: myStructType.

5. Generate code from the model.

The code generates the definition of the structure type myStructType and uses this type to define
the global variable myStruct.

myStructType myStruct = {
  2.0,
  -2.0
} ;                                    /* Variable: myStruct

Structures of Signals

This example shows how to create a structure of signal data in the generated code.

C Construct

typedef struct {
   double signal1;
   double signal2;
   double signal3;
} my_signals_type;
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Procedure

To represent a structure type in a model, create a Simulink.Bus object. Use the object as the data
type of bus signals in your model.

1. Create the ex_signal_struct model by using Gain blocks, a Bus Creator block, and a Unit Delay
block. The Gain and Unit Delay blocks make the structure more identifiable in the generated code.

2. To configure the Bus Creator block to accept three inputs, in the block dialog box, set Number of
inputs to 3.

3. In the toolstrip, on the Modeling tab, under Design, click Bus Editor.

4. In the Bus Editor, click File > Add Bus to create a Simulink.Bus object and name it
my_signals_type. Click File > Add/Insert BusElement to add three signal elements: signal1,
signal2, and signal3. For more information, see “Create and Specify Simulink.Bus Objects”.

5. Save the bus objects in your current folder as ex_signal_struct_data.mat.

This bus object represents the structure type that you want the generated code to use.

6. In the Bus Creator block dialog box, set Output data type to Bus: my_signals_type.

7. Select Output as nonvirtual bus. Click OK. A nonvirtual bus appears in the generated code as a
structure.

8. Open the Simulink Coder app. In the C Code tab, select Code Interface > Individual Element
Code Mappings.
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9. Open the Signals/States tab. In the model, select the output signal of the Bus Creator block and
click the Add selected signals to code mappings button in the Code Mappings editor.

11. For the added signal, set Storage Class to ExportedGlobal.

12. In the Property Inspector, set the Code > Identifier property to sig_struct_var. The output of
the Bus Creator block appears in the generated code as a separate global structure variable named
sig_struct_var.

13. Generate code from the model.

Results

The generated header file ex_signal_struct_types.h defines the structure type
my_signals_type.

typedef struct {
  real_T signal1;
  real_T signal2;
  real_T signal3;
} my_signals_type;

The source file ex_signal_struct.c allocates memory for the global variable sig_struct_var,
which represents the output of the Bus Creator block.

/* Exported block signals */
my_signals_type sig_struct_var;        /* '<Root>/Bus Creator' */

In the same file, in the model step function, the algorithm accesses sig_struct_var and the fields
of sig_struct_var.

Nested Structures of Signals

You can create nested structures of signal data in the generated code.

C Construct

typedef struct {
  double signal1;
  double signal2;
  double signal3;
} B_struct_type;

typedef struct {
  double signal1;
  double signal2;
} C_struct_type;

typedef struct {
  B_struct_type subStruct_B;
  C_struct_type subStruct_C;
} A_struct_type;
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Procedure

To represent a structure type in a model, create a Simulink.Bus object. Use the object as the data
type of bus signals in your model.

To nest a structure inside another structure, use a bus object as the data type of a signal element in
another bus object.

1. Create the ex_signal_nested_struct model with Gain blocks, Bus Creator blocks, and a Unit
Delay block. The Gain and Unit Delay blocks make the structure more identifiable in the generated
code.

2. To configure a Bus Creator block to accept three inputs, in the block dialog box, set Number of
inputs to 3.

3. In the toolstrip, on the Modeling tab, under Design, click Bus Editor.

In the Bus Editor, click File > Add Bus to create a Simulink.Bus object and name it
A_struct_type. Click File > Add/Insert BusElement to add two signal elements: subStruct_B
and subStruct_C. For more information, see “Create and Specify Simulink.Bus Objects”. This bus
object represents the top-level structure type that you want the generated code to use.

4. Similarly, create Simulink.Bus objects B_struct_type (with three signal elements) and
C_struct_type (with two signal elements).
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5. In A_struct_type object, for the subStruct_B element, set DataType to Bus:
B_struct_type and subStruct_C to Bus: C_struct_type.

Each signal element in A_struct_type uses another bus object as a data type. Now, these elements
represent substructures.

6. In the dialog box of the Bus Creator block that collects the three Gain signals, set Output data
type to Bus: B_struct_type. Click Apply.

7. Select Output as nonvirtual bus and click OK.

8. In the dialog box of the other subordinate Bus Creator block, set Output data type to Bus:
C_struct_type and select Output as nonvirtual bus. Click OK.

9. In the last Bus Creator block dialog box, set Output data type to Bus: A_struct_type and
select Output as nonvirtual bus. Click OK.

10. Open the Simulink Coder app. In the C Code tab, select Code Interface > Individual
Element Code Mappings.

11. Open the Signals/States tab. In the model, select the output signal of the A_struct_type Bus
Creator block, which feeds the Unit Delay block. Click the Add selected signals to code mappings
button in the Code Mappings editor.

12. For the added signal, set Storage Class to ExportedGlobal.

13. In the Property Inspector, set the Code > Identifier property to sig_struct_var. The output of
the Bus Creator block appears in the generated code as a separate global structure variable named
sig_struct_var.

14. Generate code from the model.
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Results

The generated header file ex_signal_nested_struct_types.h defines the structure types. Each
structure type corresponds to a Simulink.Bus object.

typedef struct {
  real_T signal1;
  real_T signal2;
  real_T signal3;
} B_struct_type;

typedef struct {
  real_T signal1;
  real_T signal2;
} C_struct_type;

typedef struct {
  B_struct_type subStruct_B;
  C_struct_type subStruct_C;
} A_struct_type;

The generated source file ex_signal_nested_struct.c allocates memory for the global structure
variable sig_struct_var. By default, the name of the A_struct_type Bus Creator block is Bus
Creator2.

/* Exported block signals */
A_struct_type sig_struct_var;          /* '<Root>/Bus Creator2' */

In the same file, in the model step function, the algorithm accesses sig_struct_var and the fields
of sig_struct_var.

Combine Techniques to Work Around Limitations
To work around some of the limitations of each technique, you can combine structured storage
classes with nonvirtual buses and parameter structures. For example, you can:

• Include a structure of signal data and a structure of parameter data in the same parent structure.
• Nest structures while aggregating new data by default.

In the generated code, a flat parent structure, which corresponds to the structured storage class,
contains substructures, which correspond to each bus and parameter structure. Choose one of these
combined techniques:

• Apply the structured storage class directly to each bus and parameter structure. For example, set
the storage class of two nonvirtual bus signals to Struct. Each bus appears in the generated code
as a field (substructure) of a single structure.

• Leave the storage class of each bus and parameter structure at the default setting, Auto, or at
Model default, which prevents code generation optimizations from eliminating the bus or
parameter structure. Then, configure default storage classes such that signal data and parameter
data use the structured storage class by default.
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Arrays of Structures
You can further package multiple consistent bus signals or parameter structures into an array. The
array of buses or parameter structures appears in the generated code as an array of structures. To
create arrays of buses, see “Group Nonvirtual Buses in Arrays of Buses”. To create arrays of
parameter structures, see “Group Multiple Parameter Structures into an Array”.

Structure Padding
By default, the code generator does not explicitly add padding fields to structure types. Structure
types can appear in the generated code through, for example, the standard data structures (see “Data
Structures in the Generated Code” on page 34-31), Simulink.Bus objects, and parameter structures
that you use in a model.

However, when you use a code replacement library with Embedded Coder, you can specify data
alignment (including structure padding) as part of the replacement library. For more information, see
“Provide Data Alignment Specifications for Compilers” on page 67-98.

Limitations
• With built-in Simulink Coder and Embedded Coder features, you cannot generate or use a custom

structure that contains a field whose value is a pointer. You can do so manually by creating an
advanced storage class and writing accompanying TLC code (see “Finely Control Data
Representation by Writing TLC Code for a Storage Class” on page 38-24).

• You cannot use the built-in storage class Struct, or a structured storage class that you create
with the Custom Storage Class Designer (you set the storage class property Type to
FlatStructure), to set data defaults in the Code Mapping Editor.

See Also
Simulink.Bus

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code”
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2
• “Flexible Storage Class for Different Model Hierarchy Contexts” on page 31-28
• “Types of Composite Signals”
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Switch Between Sets of Parameter Values During Simulation
and Code Execution

To store multiple independent sets of values for the same block parameters, you can use an array of
structures. To switch between the parameter sets, create a variable that acts as an index into the
array, and change the value of the variable. You can change the value of the variable during
simulation and, if the variable is tunable, during execution of the generated code.

Explore Example Model

Open the example model.

open_system('sldemo_fuelsys_dd_controller')

This model represents the fueling system of a gasoline engine. The output of the model is the rate of
fuel flow to the engine.

Navigate to the switchable_compensation nested subsystem.

open_system(['sldemo_fuelsys_dd_controller/fuel_calc/',...
     'switchable_compensation'])
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This subsystem corrects and filters noise out of the fuel rate signal. The subsystem uses different
filter coefficients based on the fueling mode, which the control logic changes based on sensor failures
in the engine. For example, the control algorithm activates the low_mode subsystem during normal
operation. It activates the rich_mode subsystem in response to sensor failure.

Open the low_mode subsystem.

open_system(['sldemo_fuelsys_dd_controller/fuel_calc/',...
     'switchable_compensation/low_mode'])

The Discrete Filter block filters the fuel rate signal. In the block dialog box, the Numerator
parameter sets the numerator coefficients of the filter.

The sibling subsystem rich_mode also contains a Discrete Filter block, which uses different
coefficients.

Update the model diagram to display the signal data types. The input and output signals of the block
use the single-precision, floating-point data type single.
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In the lower-left corner of the model, click the model data badge, then click the Data Dictionary
link. The data dictionary for this model, sldemo_fuelsys_dd_controller.sldd, opens in the
Model Explorer.

In the Model Explorer Model Hierarchy pane, select the Design Data node.

In the Contents pane, view the properties of the Simulink.NumericType objects, such as
s16En15. All of these objects currently represent the single-precision, floating-point data type
single. The model uses these objects to set signal data types, including the input and output signals
of the Discrete Filter blocks.

Suppose that during simulation and execution of the generated code, you want each of these
subsystems to switch between different numerator coefficients based on a variable whose value you
control.

Store Parameter Values in Array of Structures

Store the existing set of numerator coefficients in a Simulink.Parameter object whose value is a
structure. Each field of the structure stores the coefficients for one of the Discrete Filter blocks.

lowBlock = ['sldemo_fuelsys_dd_controller/fuel_calc/'...
    'switchable_compensation/low_mode/Discrete Filter'];
richBlock = ['sldemo_fuelsys_dd_controller/fuel_calc/'...
    'switchable_compensation/rich_mode/Discrete Filter'];
params.lowNumerator = eval(get_param(lowBlock,'Numerator'));
params.richNumerator = eval(get_param(richBlock,'Numerator'));
params = Simulink.Parameter(params);

Copy the value of params into a temporary variable. Modify the field values in this temporary
structure, and assign the modified structure as the second element of params.

temp = params.Value;
temp.lowNumerator = params.Value.lowNumerator * 2;
temp.richNumerator = params.Value.richNumerator * 2;
params.Value(2) = temp;
clear temp

The value of params is an array of two structures. Each structure stores one set of filter coefficients.

Create Variable to Switch Between Parameter Sets

Create a Simulink.Parameter object named Ctrl.

Ctrl = Simulink.Parameter(2);
Ctrl.DataType = 'uint8';

In the low_mode subsystem, in the Discrete Filter block dialog box, set the Numerator parameter to
the expression params(Ctrl).lowNumerator.

set_param(lowBlock,'Numerator','params(Ctrl).lowNumerator');

In the Discrete Filter block in the rich_mode subsystem, set the value of the Numerator parameter
to params(Ctrl).richNumerator.

set_param(richBlock,'Numerator','params(Ctrl).richNumerator');
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The expressions select one of the structures in params by using the variable Ctrl. The expressions
then dereference one of the fields in the structure. The field value sets the values of the numerator
coefficients.

To switch between the sets of coefficients, you change the value of Ctrl to the corresponding index
in the array of structures.

Use Bus Object as Data Type of Array of Structures

Optionally, create a Simulink.Bus object to use as the data type of the array of structures. You can:

• Control the shape of the structures.
• For each field, control characteristics such as data type and physical units.
• Control the name of the struct type in the generated code.

Use the function Simulink.Bus.createObject to create the object and rename the object as
paramsType.

Simulink.Bus.createObject(params.Value)
paramsType = slBus1;
clear slBus1

You can use the Simulink.NumericType objects from the data dictionary to control the data types
of the structure fields. In the bus object, use the name of a data type object to set the DataType
property of each element.

paramsType.Elements(1).DataType = 's16En15';
paramsType.Elements(2).DataType = 's16En7';

Use the bus object as the data type of the array of structures.

params.DataType = 'Bus: paramsType';

Use Enumerated Type for Switching Variable

Optionally, use an enumerated type as the data type of the switching variable. You can associate each
of the parameter sets with a meaningful name and restrict the allowed values of the switching
variable.

Create an enumerated type named FilterCoeffs. Create an enumeration member for each of the
structures in params. Set the underlying integer value of each enumeration member to the
corresponding index in params.

Simulink.defineIntEnumType('FilterCoeffs',{'Weak','Aggressive'},[1 2])

Use the enumerated type as the data type of the switching variable. Set the value of the variable to
Aggressive, which corresponds to the index 2.

Ctrl.Value = FilterCoeffs.Aggressive;

Add New Objects to Data Dictionary

Add the objects that you created to the data dictionary sldemo_fuelsys_dd_controller.sldd.

dictObj = Simulink.data.dictionary.open('sldemo_fuelsys_dd_controller.sldd');
sectObj = getSection(dictObj,'Design Data');
addEntry(sectObj,'Ctrl',Ctrl)
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addEntry(sectObj,'params',params)
addEntry(sectObj,'paramsType',paramsType)

You can also store enumerated types in data dictionaries. However, you cannot import the
enumerated type in this case because you cannot save changes to
sldemo_fuelsys_dd_controller.sldd. For more information about storing enumerated types in
data dictionaries, see “Enumerations in Data Dictionary”.

Switch Between Parameter Sets During Simulation

Open the example model sldemo_fuelsys_dd, which references the controller model
sldemo_fuelsys_dd_controller.

open_system('sldemo_fuelsys_dd')

Set the simulation stop time to Inf so that you can interact with the model during simulation.

Begin a simulation run and open the Scope block dialog box. The scope shows that the fuel flow rate
(the fuel signal) oscillates with significant amplitude during normal operation of the engine.

In the Model Explorer, view the contents of the data dictionary
sldemo_fuelsys_dd_controller.sldd. Set the value of Ctrl to FilterCoeffs.Weak.

Update the sldemo_fuelsys_dd model diagram. The scope shows that the amplitude of the fuel
rate oscillations decreases due to the less aggressive filter coefficients.

Stop the simulation.

Generate and Inspect Code

If you have Simulink Coder software, you can generate code that enables you to switch between the
parameter sets during code execution.
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In the Model Explorer, view the contents of the data dictionary
sldemo_fuelsys_dd_controller.sldd. In the Contents pane, set Column View to Storage
Class.

Use the StorageClass column to apply the storage class ExportedGlobal to params so that the
array of structures appears as a tunable global variable in the generated code. Apply the same
storage class to Ctrl so that you can change the value of the switching variable during code
execution.

Alternatively, to configure the objects, use these commands:

tempEntryObj = getEntry(sectObj,'params');
params = getValue(tempEntryObj);
params.StorageClass = 'ExportedGlobal';
setValue(tempEntryObj,params);

tempEntryObj = getEntry(sectObj,'Ctrl');
Ctrl = getValue(tempEntryObj);
Ctrl.StorageClass = 'ExportedGlobal';
setValue(tempEntryObj,Ctrl);

Generate code from the controller model.

slbuild('sldemo_fuelsys_dd_controller')

### Starting build procedure for: sldemo_fuelsys_dd_controller
### Successful completion of code generation for: sldemo_fuelsys_dd_controller

Build Summary

Top model targets built:

Model                         Action          Rebuild Reason                                    
================================================================================================
sldemo_fuelsys_dd_controller  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 58.984s

In the code generation report, view the header file sldemo_fuelsys_dd_controller_types.h.
The code defines the enumerated data type FilterCoeffs.

file = fullfile('sldemo_fuelsys_dd_controller_ert_rtw',...
    'sldemo_fuelsys_dd_controller_types.h');
rtwdemodbtype(file,'#ifndef DEFINED_TYPEDEF_FOR_FilterCoeffs_',...
    '/* Forward declaration for rtModel */',1,0)

#ifndef DEFINED_TYPEDEF_FOR_FilterCoeffs_
#define DEFINED_TYPEDEF_FOR_FilterCoeffs_

typedef enum {
  Weak = 1,                            /* Default value */
  Aggressive
} FilterCoeffs;

#endif
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The code also defines the structure type paramsType, which corresponds to the Simulink.Bus
object. The fields use the single-precision, floating-point data type from the model.

rtwdemodbtype(file,'#ifndef DEFINED_TYPEDEF_FOR_paramsType_',...
    '#ifndef DEFINED_TYPEDEF_FOR_FilterCoeffs_',1,0)

#ifndef DEFINED_TYPEDEF_FOR_paramsType_
#define DEFINED_TYPEDEF_FOR_paramsType_

typedef struct {
  real32_T lowNumerator[2];
  real32_T richNumerator[2];
} paramsType;

#endif

View the source file sldemo_fuelsys_dd_controller.c. The code uses the enumerated type to
define the switching variable Ctrl.

file = fullfile('sldemo_fuelsys_dd_controller_ert_rtw',...
    'sldemo_fuelsys_dd_controller.c');
rtwdemodbtype(file,'FilterCoeffs Ctrl = Aggressive;',...
    '/* Block signals (default storage) */',1,0)

FilterCoeffs Ctrl = Aggressive;        /* Variable: Ctrl
                                        * Referenced by:
                                        *   '<S12>/Discrete Filter'
                                        *   '<S13>/Discrete Filter'
                                        */

The code also defines the array of structures params.

rtwdemodbtype(file,'/* Exported block parameters */',...
    '/* Variable: params',1,1)

/* Exported block parameters */
paramsType params[2] = { {
    { 8.7696F, -8.5104F },

    { 0.0F, 0.2592F }
  }, { { 17.5392F, -17.0208F },

    { 0.0F, 0.5184F }
  } } ;                                /* Variable: params

The code algorithm in the model step function uses the switching variable to index into the array of
structures.

To switch between the parameter sets stored in the array of structures, change the value of Ctrl
during code execution.

Close the connections to the data dictionary. This example discards unsaved changes. To save the
changes, use the '-save' option.
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Simulink.data.dictionary.closeAll('sldemo_fuelsys_dd_controller.sldd','-discard')

See Also

Related Examples
• “Tune and Experiment with Block Parameter Values”
• “Create Tunable Calibration Parameter in the Generated Code”
• “Organize Related Block Parameter Definitions in Structures”
• “Access Structured Data Through a Pointer That External Code Defines” on page 38-10
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Design Data Interface by Configuring Inport and Outport
Blocks

The data interface of a model is the means by which the model exchanges data (for example, signal
values) with other, external models or systems. Customize the data interface of a model to:

• Enable integration of the generated code with your own code.
• Improve traceability and readability of the code.

At the top level of a model, Inport and Outport blocks represent the input and output signals of the
model. To customize the data interface in the generated code, configure these blocks. Early in the
design process, when a model can contain unconnected Inport and Outport blocks, use this technique
to specify the interface before developing the internal algorithm.

When you apply storage classes to Inport and Outport blocks, each block appears in the generated
code as a field of a global structure or as a separate global variable that the generated algorithm
references directly. If you have Embedded Coder, you can use function prototype control instead of
storage classes to pass data into and out of the model step function as formal parameters. For more
information, see “Configure C Code Generation for Model Entry-Point Functions” on page 33-112.

Design Data Interface

Open the example model rtwdemo_configrpinterface.

open_system('rtwdemo_configrpinterface')
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Configure the model to show the generated names of blocks.

set_param('rtwdemo_configrpinterface','HideAutomaticNames','off')

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, select the Inports/Outports tab. Each row in the table represents an
Outport block or a signal that exits an Inport block.

For each of the signals that exit the Inport blocks, set Data Type to single or to a different data
type. Due to the data type inheritance settings that the other blocks in the model use by default,
downstream signals in the rest of the model use the same or a similar data type.

Optionally, configure other design attributes such as Min and Max (minimum and maximum values).

Configure Default Storage Class

You can configure a default storage class for Inport blocks and Outport blocks then select the blocks
that should use the specified default.

1 Open the Simulink Coder app.
2 In the C Code tab, select Code Interface > Default Code Mappings.
3 In the Code Mappings editor, under Inports and Outports, set the default storage class for both

Inports and Outports to ExportedGlobal.
4 Next, on the Inports tab, select the data items that should use the default storage class. Press

Ctrl and click each inport.
5 For the selected inports, set the storage class to Model default: ExportedGlobal.
6 Similarly, on the Outports tab, set the storage class for the outport to Model default:

ExportedGlobal.

Alternatively, to configure the data defaults at the command prompt, use these commands:

cm = coder.mapping.api.get('rtwdemo_configrpinterface');
setDataDefault(cm,'Inports','StorageClass','ExportedGlobal');
setDataDefault(cm,'Outports','StorageClass','ExportedGlobal');

setInport(cm,'In1','StorageClass','Model default');
setInport(cm,'In2','StorageClass','Model default');
setInport(cm,'In3','StorageClass','Model default');
setInport(cm,'In4','StorageClass','Model default');

setOutport(cm,'Out1','StorageClass','Model default','Identifier','output_sig');

Generate code from the model.

slbuild('rtwdemo_configrpinterface');

### Starting build procedure for: rtwdemo_configrpinterface
### Successful completion of code generation for: rtwdemo_configrpinterface

Build Summary

Top model targets built:

Model                      Action          Rebuild Reason                                    
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=============================================================================================
rtwdemo_configrpinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.465s

View the generated file rtwdemo_configrpinterface.c. Because you applied the storage class
ExportedGlobal to the Inport and Outport blocks, the code creates separate global variables that
represent the inputs and the output.

file = fullfile('rtwdemo_configrpinterface_grt_rtw','rtwdemo_configrpinterface.c');
rtwdemodbtype(file,'/* Data with Exported storage */','real_T output_sig;',1,1)

/* Data with Exported storage */
real_T input1;                         /* '<Root>/In1' */
real_T input2;                         /* '<Root>/In2' */
real_T input3;                         /* '<Root>/In3' */
real_T input4;                         /* '<Root>/In4' */
real_T output_sig;                     /* '<Root>/Out1' */

The generated algorithm in the model step function directly references these global variables to
calculate and store the output signal value, output_sig.

Route Signal Data to Multiple Outputs

Once you have configured the default storage classes for Inports and Outports, you can choose to
override this default and set the storage class for some data elements individually. For example, you
can route a single signal to multiple Outport blocks and apply a different storage class to each
Outport. For example, use this technique to send signal data to a custom function (such as a device
driver) and to a global variable that your custom algorithmic code can use:

1 Branch the target signal line to each Outport block.
2 For more efficient code, leave the storage class of the target signal line configured to Auto (the

default). Optimizations can then eliminate the signal line from the generated code.
3 In the Code Mappings editor, on the Outports tab, apply the storage class GetSet to one

Outport block and ExportToFile to the other Outport block.
4 In the Property Inspector, configure the properties associated with each applied storage class.

open_system('ex_route_sig')
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Limitations

You cannot apply a storage class to an Outport block if the input to the block has a variable size.
Instead, apply the storage class to the signal line.

See Also

Related Examples
• “Configure Root-Level Inport Blocks for C Code Generation”
• “Configure Root-Level Outport Blocks for C Code Generation”
• “Analyze the Generated Code Interface” on page 52-13
• “Define Interfaces of Model Components”
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Configure Generated Code According to Interface Control Document Specifications” on page

38-55
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112

See Also
Code Mappings editor | coder.mapping.api.CodeMapping

34 Data Representation in Simulink Coder

34-170



Generate Efficient Code for Bus Signals

In this section...
“Code Efficiency for Bus Signals” on page 34-171
“Set Bus Diagnostics” on page 34-171
“Optimize Virtual and Nonvirtual Buses” on page 34-172

In a model, you use bus signals to package multiple signals together into a single signal line. You can
create virtual or nonvirtual bus signals. The representation in the generated code depends on:

• For a virtual bus, the generated code appears as if the bus did not exist.
• Generated code for a nonvirtual bus represents the bus data with a structure. When you want to

trace the correspondence between the model and the code, the use of a structure in the generated
code can be helpful. To generate structures using nonvirtual bus signals, see “Organize Data into
Structures in Generated Code” on page 34-145.

For general information about buses, see and “Types of Composite Signals”.

To generate efficient code from models that contain bus signals, eliminate unnecessary data copies by
following best practices as you construct the model.

Code Efficiency for Bus Signals
When you use buses in a model for which you intend to generate code:

• Setting bus diagnostic configuration parameters can make model development easier.
• The bus implementation techniques, and the choice of a nonvirtual or virtual bus, can influence

the speed, size, and clarity of the generated code.
• Some useful bus implementation techniques are not immediately obvious.

When you work with buses, these guidelines help you to improve the results. The guidelines describe
techniques to:

• Simplify the layout of the model.
• Increase the efficiency of generated code.
• Define data structures for function (subsystem) interfaces.
• Define data structures that match existing data structures in external C code.

There are some trade-offs among speed, size, and clarity. For example, the code for nonvirtual buses
is easier to read because the buses appear in the code as structures, but the code for virtual buses is
faster because virtual buses do not require copying signal data. Apply some of the guidelines based
on where you are in the application development process.

Set Bus Diagnostics
Simulink provides diagnostics that you can use to optimize bus usage. Set the following values on the
Configuration Parameters > Diagnostics > Connectivity pane.
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Optimize Virtual and Nonvirtual Buses
Virtual buses are graphical conveniences that do not affect generated code. As a result, the code
generation engine is able to fully optimize the signals in the bus. Use virtual buses rather than
nonvirtual buses wherever possible. You can convert between virtual and nonvirtual buses by using
Signal Conversion blocks. In some cases, Simulink automatically converts a virtual bus to a nonvirtual
bus when required. For example, a Stateflow chart converts an input virtual bus to a nonvirtual bus.

To bundle function-call signals, you must use a virtual bus.

You must use nonvirtual buses for:

• Nonauto storage classes
• Generating a specific structure from the bus
• Root-level Inport or Outport blocks when the bus has mixed data types

Avoid Nonlocal Nested Buses in Nonvirtual Buses

Buses can contain subordinate buses. To generate efficient code, set the storage classes of
subordinate buses to Auto. Setting the storage class to Auto eliminates:

• Allocation of redundant memory for the subordinate bus signal and for the parent bus signal
• Additional copy operations (copying data to the subordinate bus, and then copying from the

subordinate bus to the final bus)

This model contains nonvirtual bus signals. The subordinate bus signals Sub_Bus_1 and Sub_Bus_2
use the storage class Auto.
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The generated code algorithm efficiently assigns the input signal data to the bus signals.

void ex_nonvirtual_buses_step(void)
{
  Nonvirtual_In_One.SimpleBus_1.A1 = A1;
  Nonvirtual_In_One.SimpleBus_1.A2 = A2;
  Nonvirtual_In_One.SimpleBus_2.A3 = A3;
  Nonvirtual_In_One.SimpleBus_2.A4 = A4;
  Nonvirtual_In_One.A5 = A5;
}

See Also
Simulink.Bus

Related Examples
• “Organize Data into Structures in Generated Code” on page 34-145
• “Modify Sample Times for Nonvirtual Buses”
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Control Signal and State Initialization in the Generated Code
To initialize signals and discrete states with custom values for simulation and code generation, you
can use signal objects and block parameters. Data initialization increases application reliability and is
a requirement of safety critical applications. Initializing signals for both simulation and code
generation can expedite transitions between phases of Model-Based Design.

For basic information about specifying initial values for signals and discrete states in a model, see
“Initialize Signals and Discrete States”.

Signal and State Initialization in the Generated Code
The initialization behavior for code generation is the same as that for model simulation with the
following exceptions:

• RSim executables can use the Data Import/Export pane of the Configuration Parameters dialog
box to load input values from MAT-files. GRT and ERT executables cannot load input values from
MAT-files.

• The initial value for a block output signal or root level input or output signal can be overwritten by
an external (calling) program.

• Setting the initial value for persistent signals is relevant if the value is used or viewed by an
external application.

When you generate code, initialization statements are placed in model.c or model.cpp in the
model's initialize code.

For example, consider the model rtwdemo_sigobj_iv.

If you create and initialize signal objects in the base workspace, the code generator places
initialization code for the signals in the file rtwdemo_sigobj_iv.c under the
rtwdemo_sigobj_iv_initialize function, as shown below.
 /* Model initialize function */
    
     void rtwdemo_sigobj_iv_initialize(void)

     {
        .
        .
        .
 /* exported global signals */
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 S3 = -3.0;

 S2 = -2.0;
         .
         .
         .
/* exported global states */
X1 = 0.0;
X2 = 0.0;

/* external inputs */
S1 = -4.5;
         .
         .
         .

The following code shows the initialization code for the enabled subsystem's Unit Delay block state
X1 and output signal S2.
void MdlStart(void) {
          .
          .
          .
 /* InitializeConditions for UnitDelay: '<S2>/Unit Delay' */
  X1 = aa1;

 /* Start for enable system: '<Root>/Enabled Subsystem (state X1 inside)' */

  /* virtual outports code */

  /* (Virtual) Outport Block: '<S2>/Out1' */

  S2 = aa2;

}

For an enabled subsystem, the initial value is also used as a reset value if the subsystem's Outport
block parameter Output when disabled is set to reset. The following code from
rtwdemo_sigobj_iv.c shows the assignment statement for S3 as it appears in the model output
function rtwdemo_sigobj_iv_output.
/* Model output function */

static void rtwdemo_sigobj_iv_output(void)
{
         .
         .
         .
 /* Disable for enable system: '<Root>/Enabled Subsystem (state X1 inside)' */

    /* (Virtual) Outport Block: '<S2>/Out1' */

    S2 = aa2;

Generate Tunable Initial Conditions
You can represent initial conditions for signals and states by creating tunable global variables in the
generated code. These variables allow you to restart an application by using initial conditions that are
stored in memory.

If you set Configuration Parameters > Optimization > Default parameter behavior to
Tunable, initial conditions appear as tunable fields of the global parameters structure.

Whether you set Default parameter behavior to Tunable or Inlined, you can use a tunable
parameter to specify the InitialValue property of a signal object or the Initial condition
parameter of a block. For basic information about tunable parameters, see “Create Tunable
Calibration Parameter in the Generated Code”.

This example shows how to use tunable parameters to specify initial conditions for signals and states.
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Explore Example Model

Open the example model rtwdemo_sigobj_iv and configure it to show the generated names of
blocks. The signal S2 uses a Simulink.Signal object in the base workspace.

Double-click the Simulink.Signal object S2 to view its properties. The Initial value property is
set to aa2. The object uses the variable aa2 to specify an initial condition for the signal S2. The
Storage class property is set to ExportedGlobal. To use a Simulink.Signal object to initialize a
signal, the signal object must use a storage class other than Auto or, if the corresponding data
category in the Code Mapping Editor uses a storage class setting other than Default, Model
default.

On the Optimization pane, in the Configuration Parameters dialog box, click Configure. The
variable aa2 is a tunable parameter that uses the storage class ExportedGlobal.

In the model, open the Enabled Subsystem. In the Outport block dialog box, the parameter Output
when disabled is set to reset. When the subsystem becomes disabled, the output signal S2 resets
to the initial value aa2.

Open the Unit Delay block dialog box. On the State Attributes tab, the State name box is set to X1.

Open the Enable block dialog box. The parameter States when enabling is set to reset. When the
subsystem transitions from a disabled state to an enabled state, it resets internal block states, such
as X1, to their initial values.

In the base workspace, double-click the Simulink.Signal object X1 to view its properties. The
Initial value property is set to aa1.

Double-click the Simulink.Parameter object aa1 to view its properties. The Storage class
property is set to ExportedGlobal. You can generate tunable initial conditions for block states by
using tunable parameters such as aa1 and Simulink.Signal objects such as X1.
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Generate and Inspect Code

Generate code with the example model.

### Starting build procedure for: rtwdemo_sigobj_iv
### Successful completion of build procedure for: rtwdemo_sigobj_iv

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                                    
==================================================================================================
rtwdemo_sigobj_iv  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.64s

In the code generation report, view the file rtwdemo_sigobj_iv.c. The code uses global variables
to represent the block state X1 and the signal S2.

/* Exported block states */
real_T X1;                             /* '<S1>/Unit Delay' */

/* Exported block signals */
real_T S1;                             /* '<Root>/In1' */
real_T S3;                             /* '<Root>/Signal Conversion' */
real_T S2;                             /* '<S1>/Unit Delay' */

The code uses global variable to represent the tunable parameter aa1.

/* Exported block parameters */
real_T aa1 = -2.5;                     /* Variable: aa1

The model initialization function uses the tunable parameter aa1 to initialize the state X1. The
function also uses the tunable parameter aa2 to initialize the signal S2.

  /* SystemInitialize for Enabled SubSystem: '<Root>/Enabled Subsystem (state X1 inside)' */
  /* InitializeConditions for UnitDelay: '<S1>/Unit Delay' */
  X1 = aa1;

  /* SystemInitialize for UnitDelay: '<S1>/Unit Delay' incorporates:
   *  Outport: '<S1>/Out1'
   */
  S2 = 0.0;

In the model step function, when the Enabled Subsystem transitions from a disabled state to an
enabled state, the Unit Delay block state X1 resets to its initial value.

  if (rtb_PulseGenerator > 0) {
    if (!rtwdemo_sigobj_iv_DW.EnabledSubsystemstateX1inside_M) {
      /* InitializeConditions for UnitDelay: '<S1>/Unit Delay' */
      X1 = aa1;
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      rtwdemo_sigobj_iv_DW.EnabledSubsystemstateX1inside_M = true;
    }

    /* UnitDelay: '<S1>/Unit Delay' */
    S2 = X1;

    /* Update for UnitDelay: '<S1>/Unit Delay' incorporates:
     *  Inport: '<Root>/In1'
     */
    X1 = S1;
  } else if (rtwdemo_sigobj_iv_DW.EnabledSubsystemstateX1inside_M) {
    /* Disable for UnitDelay: '<S1>/Unit Delay' incorporates:
     *  Outport: '<S1>/Out1'
     */
    S2 = 0.0;
    rtwdemo_sigobj_iv_DW.EnabledSubsystemstateX1inside_M = false;
  }

  /* End of Outputs for SubSystem: '<Root>/Enabled Subsystem (state X1 inside)' */

  /* DataStoreWrite: '<Root>/Data Store Write' */
  X2 = S2;

  /* SignalConversion: '<Root>/Signal Conversion' incorporates:
   *  DataStoreRead: '<Root>/Data Store Read'
   */
  S3 = X2;
}

/* Model initialize function */
void rtwdemo_sigobj_iv_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_sigobj_iv_M, (NULL));

  /* block I/O */

  /* exported global signals */
  S3 = -3.0;

  /* states (dwork) */
  (void) memset((void *)&rtwdemo_sigobj_iv_DW, 0,
                sizeof(DW_rtwdemo_sigobj_iv_T));

  /* exported global states */
  X1 = 0.0;
  X2 = 0.0;

  /* external inputs */
  S1 = -4.5;

  /* Start for DiscretePulseGenerator: '<Root>/Pulse Generator' */
  rtwdemo_sigobj_iv_DW.clockTickCounter = -2;

  /* Start for DataStoreMemory: '<Root>/Data Store Memory' */
  X2 = -3.5;
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  /* SystemInitialize for Enabled SubSystem: '<Root>/Enabled Subsystem (state X1 inside)' */
  /* InitializeConditions for UnitDelay: '<S1>/Unit Delay' */
  X1 = aa1;

  /* SystemInitialize for UnitDelay: '<S1>/Unit Delay' incorporates:
   *  Outport: '<S1>/Out1'
   */
  S2 = 0.0;

  /* End of SystemInitialize for SubSystem: '<Root>/Enabled Subsystem (state X1 inside)' */
}

/* Model terminate function */
void rtwdemo_sigobj_iv_terminate(void)
{
  /* (no terminate code required) */
}

If the Enabled Subsystem becomes disabled during code execution, the algorithm uses the tunable
initial condition aa2 to set the value of the signal S2.

  } else {

  } else if (rtwdemo_sigobj_iv_DW.EnabledSubsystemstateX1inside_M) {
    /* Disable for UnitDelay: '<S1>/Unit Delay' incorporates:
     *  Outport: '<S1>/Out1'
     */
    S2 = 0.0;
    rtwdemo_sigobj_iv_DW.EnabledSubsystemstateX1inside_M = false;
  }

Generate Tunable Initial Condition Structure for Bus Signal
When you use a MATLAB® structure to specify initialization values for the signal elements in a bus,
you can create a tunable global structure in the generated code.

If you set Configuration Parameters > Optimization > Default parameter behavior to
Tunable, the initial condition appears as a tunable substructure of the global parameters structure.

Whether you set Default parameter behavior to Tunable or Inlined, you can specify the initial
condition by using a tunable Simulink.Parameter object whose value is a structure. If you apply a
storage class other than Auto to the parameter object, the structure is tunable in the generated code.

To generate efficient code by avoiding data type mismatches between the structure and the bus
signal, use either:

• Typed expressions to specify the values of the structure fields. Match the data type of each field
with the data type of the corresponding signal element.

• A Simulink.Bus object to control the data types of the structure fields and the signal elements.

For basic information about using structures to initialize bus signals, and to decide how to control
field data types, see “Specify Initial Conditions for Bus Elements”.
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Generate Tunable Initial Condition Structure

This example shows how to use a tunable structure parameter to initialize a virtual bus signal.

Open the example model rtwdemo_tunable_init_struct and configure it to show the generated
names of blocks.

On the Modeling tab, click Model Data Editor.

On the Inports/Outports tab, the Data Types column shows that each Inport block in the model
uses a different output data type.

Open the Bus Creator block dialog box. The block output is a virtual bus.

In the Configuration Parameters dialog box, open the Optimization pane. The configuration
parameter Default parameter behavior is set to Tunable. By default, block parameters, including
initial conditions, appear in the generated code as tunable fields of the global parameters structure.

In the Model Data Editor, inspect the States tab.

For the Unit Delay block, set Initial Value to a structure that specifies an initial condition for each of
the three signal elements. To generate efficient code, match the data types of the structure fields with
the data types of the corresponding signal elements. For example, set Initial Value to the expression
struct('thermocpl',15.23,'magFlow',uint32(79),'posSwitch',false).

set_param('rtwdemo_tunable_init_struct/Unit Delay','InitialCondition',...
'struct(''thermocpl'',15.23,''magFlow'',uint32(79),''posSwitch'',false)')

Generate code from the example model.

### Starting build procedure for: rtwdemo_tunable_init_struct
### Successful completion of build procedure for: rtwdemo_tunable_init_struct

Build Summary

34 Data Representation in Simulink Coder

34-180



Top model targets built:

Model                        Action                       Rebuild Reason                                    
============================================================================================================
rtwdemo_tunable_init_struct  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.383s

In the code generation report, view the file rtwdemo_tunable_init_struct_types.h. The code
defines a structure type whose fields use the data types that you specified in the struct expression.

#ifndef DEFINED_TYPEDEF_FOR_struct_mqGi1jsItE0G7cf1bNqMu_
#define DEFINED_TYPEDEF_FOR_struct_mqGi1jsItE0G7cf1bNqMu_

typedef struct {
  real_T thermocpl;
  uint32_T magFlow;
  boolean_T posSwitch;
} struct_mqGi1jsItE0G7cf1bNqMu;

View the file rtwdemo_tunable_init_struct.h. The struct type definition of the global
parameters structure contains a substructure, UnitDelay_InitialCondition, which represents
the Initial condition parameter of the Unit Delay block.

struct P_rtwdemo_tunable_init_struct_T_ {
  struct_mqGi1jsItE0G7cf1bNqMu UnitDelay_InitialCondition;

View the file rtwdemo_tunable_init_struct_data.c. This source file allocates memory for the
global parameters structure. The substructure UnitDelay_InitialCondition appears.

/* Block parameters (default storage) */
P_rtwdemo_tunable_init_struct_T rtwdemo_tunable_init_struct_P = {
  /* Mask Parameter: UnitDelay_InitialCondition
   * Referenced by:
   *   '<Root>/Unit Delay'
   *   '<Root>/Unit Delay'
   *   '<Root>/Unit Delay'
   */
  {
    15.23,
    79U,
    0
  },

View the file rtwdemo_tunable_init_struct.c. The model initialization function uses the fields
of the substructure to initialize the block states.

  /* InitializeConditions for UnitDelay generated from: '<Root>/Unit Delay' */
  rtwdemo_tunable_init_struct_DW.UnitDelay_1_DSTATE =
    rtwdemo_tunable_init_struct_P.UnitDelay_InitialCondition.thermocpl;

  /* InitializeConditions for UnitDelay generated from: '<Root>/Unit Delay' */
  rtwdemo_tunable_init_struct_DW.UnitDelay_2_DSTATE =
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    rtwdemo_tunable_init_struct_P.UnitDelay_InitialCondition.magFlow;

  /* InitializeConditions for UnitDelay generated from: '<Root>/Unit Delay' */
  rtwdemo_tunable_init_struct_DW.UnitDelay_3_DSTATE =
    rtwdemo_tunable_init_struct_P.UnitDelay_InitialCondition.posSwitch;

Use Bus Object to Specify Data Types

If you create a bus object, you can use it to specify the data type of the bus signal and the tunable
initial condition structure. Before code generation, the Simulink.Parameter object casts the values
of the structure fields to the data types of the signal elements. For basic information about creating
bus objects and using them in models, see “Specify Bus Properties with Simulink.Bus Object Data
Types”.

Open the example model rtwdemo_init_struct_busobj and configure it to show the generated
names of blocks.

In the base workspace, double-click the Simulink.Bus object ComponentData. The object defines
three signal elements: thermocpl, magFlow, and posSwitch. The elements each use a different
data type.

In the model, open the Model Data Editor (on the Modeling tab, click Model Data Editor). The
Inports/Outports tab shows that for the Inport block DataIn, the output data type (Data Type
column) is set to Bus: ComponentData.

At the command prompt, create the structure parameter initStruct. You can specify the field
values by using untyped expressions. To improve readability, specify the field posSwitch with a
Boolean value.

initStruct = struct(...
    'thermocpl',15.23,...
    'magFlow',79,...
    'posSwitch',false ...
    );
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initStruct = Simulink.Parameter(initStruct);

In the Model Data Editor, inspect the Parameters tab.

In the model, click the Unit Delay block. The Model Data Editor highlights the row that corresponds
to the Initial condition parameter of the block.

In the Model Data Editor, set the parameter value (Value column) to initStruct.

Click the Show/refresh additional information button. The parameter object, initStruct,
appears in the data table as a row.

Use the Data Type column to set the data type of initStruct to Bus: ComponentData.

initStruct.DataType = 'Bus: ComponentData';

Set the Change View drop-down list to Code.

Use the Storage Class column to apply the storage class ExportedGlobal to initStruct.

initStruct.StorageClass = 'ExportedGlobal';

Generate code from the example model.

### Starting build procedure for: rtwdemo_init_struct_busobj
### Successful completion of build procedure for: rtwdemo_init_struct_busobj

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
rtwdemo_init_struct_busobj  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.454s

In the code generation report, view the file rtwdemo_init_struct_busobj_types.h. The code
creates a structure type ComponentData whose fields use the data types in the bus object.

#ifndef DEFINED_TYPEDEF_FOR_ComponentData_
#define DEFINED_TYPEDEF_FOR_ComponentData_

typedef struct {
  real_T thermocpl;
  uint32_T magFlow;
  boolean_T posSwitch;
} ComponentData;

View the file rtwdemo_init_struct_busobj.c. The code creates a global variable to represent the
tunable parameter object initStruct.

/* Exported block parameters */
ComponentData initStruct = {
  15.23,
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  79U,
  0
} ;                                    /* Variable: initStruct

The model initialization function uses the structure fields to initialize the block states.

  /* InitializeConditions for UnitDelay generated from: '<Root>/Unit Delay' */
  rtwdemo_init_struct_busobj_DW.UnitDelay_1_DSTATE = initStruct.thermocpl;

  /* InitializeConditions for UnitDelay generated from: '<Root>/Unit Delay' */
  rtwdemo_init_struct_busobj_DW.UnitDelay_2_DSTATE = initStruct.magFlow;

  /* InitializeConditions for UnitDelay generated from: '<Root>/Unit Delay' */
  rtwdemo_init_struct_busobj_DW.UnitDelay_3_DSTATE = initStruct.posSwitch;

To change the data type of a signal element, specify the new type in the bus object. The signal
element in the model uses the new type. Before simulation and code generation, the parameter object
initStruct casts the corresponding structure field to the new type.

See Also
State Reader | State Writer

Related Examples
• “Initialization Behavior Summary for Signal Objects”
• “Specify Initial Conditions for Bus Elements”
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
• “Generate Code That Responds to Initialize, Reset, and Terminate Events” on page 11-2
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Initialization of Signal, State, and Parameter Data in the Generated Code” on page 34-185
• “Remove Zero Initialization Code” on page 72-3
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Initialization of Signal, State, and Parameter Data in the
Generated Code

Signal lines, block parameters, and block states in a model can appear in the generated code as data,
for example, as global variables. By default, the code initializes this data before execution of the
primary algorithm. To match the numerics of simulation in Simulink, the code generator chooses the
initial values based on specifications that you make in the model.

By understanding how the generated code initializes data, you can:

• Model a system that reinitializes states during execution, which means that the application can
restart the entire system.

• Store initial values in memory as variables, which can persist between execution runs. You can
then overwrite these values before starting or restarting a system.

• Generate efficient code by eliminating storage for invariant initial values and by preventing the
generation of code that unnecessarily or redundantly initializes data.

For basic information about initializing signals and states in a model, see “Initialize Signals and
Discrete States” and “Load State Information”.

Static Initialization and Dynamic Initialization
To initialize a data item such as a global variable, an application can use static or dynamic
initialization.

• Static initialization occurs in the same statement that defines (allocates memory for) the variable.
The initialization does not occur inside a function definition.

The code can be more efficient because none of the generated model functions execute
initialization statements.

• Dynamic initialization occurs inside a function. For each model or nonvirtual subsystem, the code
generator typically creates one or more functions that are dedicated to initialization.

The generated code or your code can restart a system by calling an initialization function during
execution.

Real-World Ground Initialization Requiring Nonzero Bit Pattern
Each data item has a real-world ground value. This value can depend on the data type of the item. For
example, for a signal whose data type is double or int8, the real-world ground value is zero. For an
enumeration, the ground value is the default enumeration member.

For some kinds of data, to represent a real-world ground value, a computer stores zero in memory (all
bits zero). However, for some other data, a computer stores a nonzero value in memory. This data
includes, for example:

• Fixed-point data with bias. The code initializes such a data item to the stored integer value that,
given the scaling and bias, represents real-world zero.

• An enumeration whose default member maps to an integer value other than zero. For example, if
the default member is High with an underlying integer value of 3, the code initializes such a data
item to High.
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Initialization of Signal and State Data
In a model, you can control signal and state initial values through block parameters. For example, to
set the initial value of a Unit Delay block, you use the Initial condition parameter. In some cases,
you can also use the InitialValue property of a Simulink.Signal object. For most of these block
parameters, the default value is 0.

You can also initialize states by using State Writer blocks in Initialize Function subsystems and the
Initial states model configuration parameter.

By default, the generated code dynamically initializes signal and state data (and other data, such as
the model error status) in the generated initialization function. The function, named
model_initialize by default, performs signal and state initialization operations in this order:

1 Initializes the signal and state data in the default generated structures, such as the DWork
structure, to a stored value of zero.

2 Initializes additional signal and state data that are not in the default generated structures to the
relevant real-world ground value.

This initialization applies only to data that meet both of these criteria:

• The generated code defines (allocates memory for) the data.
• The data use a storage class other than Auto (the default storage class) or Model default

(when the Code Mapping Editor specifies the Default storage class, the default setting).

For example, the code applies this operation to data items that use the storage class
ExportedGlobal.

3 Initializes each signal and state to the real-world value that the model specifies, for example,
through the Initial condition parameter of a Unit Delay block.

4 Initializes each state to the real-world value that you assign by using a State Writer block. The
function performs this initialization only if you use an Initialize Function subsystem in the model.

5 Initializes each state to the real-world value that you specify with the configuration parameter
Initial states.

After this initialization function executes, each data item has the last real-world value that the
function assigned. For example, if you use a State Writer block to initialize a block state to 5 while
also using the Initial states configuration parameter to initialize the same state to 10, the state
ultimately uses 10 as an initial value.

memset for Bulk Initialization

To initialize signal or state data items that have contiguous storage to a stored value of zero, the
generated code can call memset in an initialization function. Data items that have contiguous storage
include the DWork structure, arrays, or data items that use a multiword data type.

If your application requires it, you can prevent the generated code from using memset for initializing
floating-point data to stored zero. See “Use memset to initialize floats and doubles to 0.0”.

Tunable Initial Values

You can configure the way that tunable block parameters, such as the Gain parameter of a Gain
block, appear in the generated code. Most block parameters that set initial values (for example,
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Initial condition) are tunable. For example, the configuration parameter Default parameter
behavior can determine whether the initial values appear in the generated code as inlined constants
or as tunable global data. You can also use parameter objects and storage classes to control the
representation of these initial values.

For tunable initial values, in the model initialization function, the right-hand side of the assignment
statement is a global variable, structure field, or other data whose value you can change in memory.

To make initial values tunable in the generated code, see “Control Signal and State Initialization in
the Generated Code” on page 34-174.

Initialization of Parameter Data
The generated code statically initializes parameter data to the values that you specify in Simulink.

To express the initial value of a tunable parameter (a global variable) as a mathematical expression
involving system constants or other macros, which requires Embedded Coder, see “Initialization by
Mathematical Expression (Embedded Coder)”.

Kinds of Parameter Data

These model elements appear in the generated code as parameter data:

• Tunable block parameters, such as the Gain parameter of a Gain block, when you set Default
parameter behavior to Tunable. Each parameter appears as a field of a dedicated global
structure.

• Some tunable block parameters when you set Default parameter behavior to Inlined. When
the code generator cannot inline the value of a parameter as a literal number, the parameter
appears as a field of a dedicated global const structure.

• Simulink.Parameter objects to which you apply a storage class that has an exported data
scope. For example, the built-in storage class ExportedGlobal has an exported data scope, but
the storage class ImportedExtern does not.

Initialization by Mathematical Expression (Embedded Coder)

You can set the value of a parameter object (such as Simulink.Parameter) to a mathematical
expression involving numbers, MATLAB variables, and other parameter objects. See “Set Variable
Value by Using a Mathematical Expression”.

If you use this technique with Embedded Coder, you can generate code that initializes the
corresponding parameter data (global variable) by using the specified expression. For an example,
see “Initialize Parameter Value From System Constant or Other Macro (Embedded Coder)” on page
34-116. For general information, including limitations, see “Code Generation of Parameter Objects
With Expression Values”.

Data Initialization in the Generated Code
This example shows how the generated code initializes signal, state, and parameter data.

Explore Example Model

Open the example model, rtwdemo_rtwintro.
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open_system('rtwdemo_rtwintro')

In the Apps gallery, click Simulink Coder.

Open the Model Data Editor. On the Modeling tab, click Model Data Editor.

Inspect the States tab. For the Unit Delay block state, the Initial Value is set to 0, the default, which
means the initial value of the state is zero. The state is named X.

Set Initial Value to a nonzero number, for example, 5.

set_param('rtwdemo_rtwintro/X','InitialCondition','5')

Open the Code Mappings editor. In the C Code tab, select Code Interface > Individual Element
Code Mappings.

On the Signals/States tab, under States set Storage Class for X to ExportedGlobal. With this
setting, the block state appears in the generated code as a separate global variable.

coder.mapping.utils.create('rtwdemo_rtwintro');
cm = coder.mapping.api.get('rtwdemo_rtwintro');
setState(cm,'rtwdemo_rtwintro/X','StorageClass','ExportedGlobal');

In the model, open the Amplifier subsystem, which is a triggered subsystem.

In the Model Data Editor, inspect the Parameters tab. To set and inspect initial values of signals and
states, you can use the Parameters tab instead of the States tab.

The Model Data Editor shows that for the Outport block, the Initial output (InitialOutput)
parameter is set to 0, the default. This subsystem output requires an initial value because the
subsystem executes conditionally. Leave the initial value at the default.

In the model, clear Configuration Parameters > Signal storage reuse. When you clear this
setting, signal lines appear in the generated code as fields of a generated structure whose purpose is
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to store signal data. This representation of the signals makes it easier to see how the code generator
initializes data.

set_param('rtwdemo_rtwintro','OptimizeBlockIOStorage','off')

In the model, inspect the configuration parameter Configuration Parameters > Optimization >
Default parameter behavior. The configuration parameter is set to Inlined, which means block
parameters, including initial values, appear in the generated code as inlined literals or as const
data.

Navigate to the root level of the model.

In the Model Data Editor, click the Show/refresh additional information button.

Near the Filter contents box, click the Filter using selection button.

In the model, click the Constant block labeled INC. The Model Data Editor shows that the Constant
value (Value) parameter of the block is set to INC. INC is a MATLAB variable in the base workspace.

For INC, set the value in the Value column to Simulink.Parameter(uint8(1)). MATLAB converts
INC to a Simulink.Parameter object.

In the Code Mappings editor, on the Parameters tab, apply the storage class ExportedGlobal to
INC. With this setting, the generated code defines INC as a global variable. Concerning initialization,
INC is an item of parameter data.

INC = Simulink.Parameter(INC);
INC.StorageClass = 'ExportedGlobal';

Generate and Inspect Code

To build the model and generate code, press Ctrl+B .

slbuild('rtwdemo_rtwintro');

### Starting build procedure for: rtwdemo_rtwintro
### Successful completion of build procedure for: rtwdemo_rtwintro

Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
rtwdemo_rtwintro  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.142s

In the generated file rtwdemo_rtwintro.c, outside the definition of a function, the code statically
initializes the parameter data INC. The value of INC is 1.

file = fullfile('rtwdemo_rtwintro_grt_rtw','rtwdemo_rtwintro.c');
rtwdemodbtype(file,'/* Exported block parameters */','uint8_T INC = 1U;',1,1)

/* Exported block parameters */
uint8_T INC = 1U;                      /* Variable: INC
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In the same file, inspect the definition of the rtwdemo_rtwintro_initialize function. First, the
function uses memset to initialize the internal signals in the model to a stored value of 0.

rtwdemodbtype(file,'/* block I/O */','sizeof(B_rtwdemo_rtwintro_T));',1,1)

  /* block I/O */
  (void) memset(((void *) &rtwdemo_rtwintro_B), 0,
                sizeof(B_rtwdemo_rtwintro_T));

The function then initializes the Unit Delay state, X, to a ground value. In this case, the ground value
is zero.

rtwdemodbtype(file,'/* exported global states */','X = 0U;',1,1)

  /* exported global states */
  X = 0U;

The function also initializes other data, including the root-level inputs and outputs (Inport and
Outport blocks), to ground values.

rtwdemodbtype(file,'/* external inputs */','Amplifier_Trig_ZCE = POS_ZCSIG;',1,1)

  /* external inputs */
  rtwdemo_rtwintro_U.Input = 0;

  /* external outputs */
  rtwdemo_rtwintro_Y.Output = 0;
  rtwdemo_rtwintro_PrevZCX.Amplifier_Trig_ZCE = POS_ZCSIG;

The function then initializes X to the value that you specified in the Initial condition block
parameter.

rtwdemodbtype(file,'/* InitializeConditions for UnitDelay: ''<Root>/X'' */',...
    'X = 5U;',1,1)

  /* InitializeConditions for UnitDelay: '<Root>/X' */
  X = 5U;

Finally, the function initializes the output of the Amplifier subsystem.

rtwdemodbtype(file,'SystemInitialize for Triggered SubSystem',...
    'End of SystemInitialize for SubSystem',1,1)

  /* SystemInitialize for Triggered SubSystem: '<Root>/Amplifier' */
  /* SystemInitialize for Outport: '<Root>/Output' incorporates:
   *  Outport: '<S1>/Out'
   */
  rtwdemo_rtwintro_Y.Output = 0;
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Inspect Difference Between Stored Value and Real-World Value

For some data, even if the real-world initial value is zero, a computer stores a nonzero value in
memory. To observe this difference, apply a slope-bias fixed-point data type to the block state, X. To
run this example, you must have Fixed-Point Designer™.

In the Model Data Editor, inspect the Signals tab.

In the model, click the output signal of the Switch block, switch_out.

Use the Data Type column of the Model Data Editor to set the signal data type to
fixdt(1,16,1,3). This expression represents a fixed-point data type with a slope of 1 and a bias of
3.

set_param('rtwdemo_rtwintro/Switch','OutDataTypeStr',...
    'fixdt(1,16,1,3)')

In the model, select the Sum block. In the Property Inspector, under Signal Attributes, clear
Require all inputs to have the same data type.

set_param('rtwdemo_rtwintro/Sum','InputSameDT','off')

To prevent compilation errors on different platforms, select the model configuration parameter
Generate code only. This setting causes the model to generate only code.

set_param('rtwdemo_rtwintro','GenCodeOnly','on')

To build the model and generate code, press Ctrl+B .

slbuild('rtwdemo_rtwintro')

### Starting build procedure for: rtwdemo_rtwintro
### Successful completion of code generation for: rtwdemo_rtwintro

Build Summary

Top model targets built:

Model             Action          Rebuild Reason                   
===================================================================
rtwdemo_rtwintro  Code generated  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 7.9s

The model initialization function first initializes X to a real-world ground value, 0. Due to the slope-
bias data type, which has bias 3, this real-world value corresponds to a stored value of -3.

rtwdemodbtype(file,'/* exported global states */','X = -3;',1,1)

  /* exported global states */
  X = -3;

The function then initializes X to the real-world initial value that you specified in the Initial
condition block parameter, 5. This real-world value corresponds to a stored value of 2.

rtwdemodbtype(file,'/* InitializeConditions for UnitDelay: ''<Root>/X'' */',...
    'X = 2;',1,1)
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  /* InitializeConditions for UnitDelay: '<Root>/X' */
  X = 2;

Modeling Goals
Goal More Information
Explicitly model
initialization behavior
by using blocks

You can explicitly model initialization and reset behavior by using Initialize
Function and Reset Function subsystems. In the subsystems, use State Writer
blocks to calculate and assign an initial value for a state dynamically. The
corresponding code appears in the model initialization function.

For more information, see “Generate Code That Responds to Initialize, Reset,
and Terminate Events” on page 11-2.

Prevent generation of
code that explicitly
initializes data to zero

If your application environment already initializes global variables to zero, for
more efficient code, you can prevent the generation of statements that
explicitly initialize global variables to zero. This optimization applies only to
signals and states whose initial values are stored in memory as zero. For
example, the code generator does not apply the optimization to:

• Data for which you specify a nonzero initial value by using a block
parameter.

• Data whose real-world initial value is zero but whose corresponding stored
value is not zero.

• Enumerated data whose default member maps to a nonzero integer.

The optimization requires Embedded Coder. For more information, see
“Remove Zero Initialization Code” on page 72-3.

Generate code that
imports data from
your external code

You can generate code that reuses (imports) data that your external code
defines. For example, you can apply the storage class ImportedExtern to a
signal line, block state, or parameter object. For imported data:

• The generated code does not initialize parameter data. Your code must
initialize imported parameter data.

• The generated initialization functions dynamically initialize some signal
and state data. Unlike data that the generated code allocates, the code
does not initialize imported signal or state data to a stored value of zero.
Instead, the code immediately initializes the data to the real-world value
that you specify in Simulink.

For more information, including how to prevent the generated code from
initializing imported data, see “Exchange Data Between External Calling Code
and Generated Code”.

See Also
model_initialize
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Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Optimize Speed and Size of Signal Processing Algorithm by
Using Fixed-Point Data

This model shows a fixed-point version of an acoustic noise canceller.

See Also

More About
• “Fixed Point”
• “Acoustic Noise Cancellation (LMS)” (DSP System Toolbox)
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Optimize Generated Code Using Fixed-Point Data with
Simulink®, Stateflow®, and MATLAB®

This model shows fixed-point code generation in Simulink®, Stateflow®, and MATLAB®.

open_system ('rtwdemo_fixpt1');

See Also

More About
• “Fixed Point”
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Declare Workspace Variables as Tunable Parameters Using the
Model Parameter Configuration Dialog Box

You can use the Model Parameter Configuration dialog box to declare numeric MATLAB variables in
the base workspace as tunable parameters. You can select code generation options, such as storage
class, for each tunable parameter.

However, it is a best practice to instead use parameter objects to declare tunable parameters. Do not
use the Model Parameter Configuration dialog box to select parameter objects in the base workspace.
To use parameter objects, instead of the Model Parameter Configuration dialog box, to declare
tunable parameters, see “C Code Generation Configuration for Model Interface Elements” on page
33-2.

Note You cannot use the Model Parameter Configuration dialog box to declare tunable parameters
for a referenced model. Use Simulink.Parameter objects instead.

Declare Existing Workspace Variables as Tunable Parameters
Use the Model Parameter Configuration dialog box to declare existing workspace variables as tunable
parameters for a model.

1 In the Configuration Parameters dialog box, on the Code Generation > Optimization pane, set
the Default parameter behavior parameter to Tunable and click Configure.

2 In the Model Parameter Configuration dialog box, under Source list, select a method to populate
the list of available workspace variables.

• Select MATLAB workspace to view numeric variables that are defined in the base workspace.
• Select Referenced workspace variables to view only the numeric variables in the base

workspace that the model uses. Selecting this option begins a diagram update and a search
for used variables, which can take time for a large model.

3 In the Model Parameter Configuration dialog box, under Source list, select one or more
workspace variables.

4 Click Add to table. The variables appear as tunable parameters under Global (tunable)
parameters, and appear in italic font under Source list.

5 Optionally, select a parameter under Global (tunable) parameters, and adjust the code
generation settings for the parameter. For more information about adjusting the code generation
options for tunable parameters, see “Set Tunable Parameter Code Generation Options” on page
34-197

6 Click OK to apply your selection of tunable parameters and close the dialog box.

Declare New Tunable Parameters
Use the Model Parameter Configuration dialog box to declare new tunable parameters. You can use
this technique to declare the names of tunable parameters, and to adjust their code generation
settings, before you create the corresponding workspace variables.

1 In the Configuration Parameters dialog box, on the Optimization pane, set the Default
parameter behavior parameter to Tunable and click Configure.
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2 In the Model Parameter Configuration dialog box, under Global (tunable) parameters, click
New.

3 Under the Name column, specify a name for the new tunable parameter.
4 Optionally, adjust the code generation settings for the new parameter. For more information

about adjusting the code generation options for tunable parameters, see “Set Tunable Parameter
Code Generation Options” on page 34-197

5 Click OK to apply your changes and close the dialog box.

Set Tunable Parameter Code Generation Options
To set the properties of tunable parameters listed under Global (tunable) parameters in the Model
Parameter Configuration dialog box, select a parameter and specify a storage class and, optionally, a
storage type qualifier.

Property Description
Storage class Select one of the following to use for code generation:

• Model default
• ExportedGlobal
• ImportedExtern
• ImportedExternPointer

For more information about tunable parameter storage classes,
see “C Code Generation Configuration for Model Interface
Elements” on page 33-2.

Storage type qualifier For variables with a storage class other than Auto, you can
add a qualifier (such as const or volatile) to the generated
storage declaration. To do so, you can select a predefined
qualifier from the list, or add qualifiers not in the list by typing
them in. The code generator does not check the storage type
qualifier for validity, and includes the qualifier text in the
generated code without checking syntax .

Programmatically Declare Workspace Variables as Tunable Parameters
Tune Parameters from the Command Line

When parameters are MATLAB workspace variables, the Model Parameter Configuration dialog box is
the recommended way to see or set the properties of tunable parameters. In addition to that dialog
box, you can also use MATLAB get_param and set_param commands.

Note You can also use Simulink.Parameter objects for tunable parameters. See “Create Tunable
Calibration Parameter in the Generated Code” on page 34-109 for details.

The following commands return the tunable parameters and corresponding properties:

• get_param(gcs,'TunableVars')
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• get_param(gcs,'TunableVarsStorageClass')
• get_param(gcs,'TunableVarsTypeQualifier')

The following commands declare tunable parameters or set corresponding properties:

• set_param(gcs,'TunableVars',str)

The argument str (character vector) is a comma-separated list of variable names.
• set_param(gcs,'TunableVarsStorageClass',str)

The argument str (character vector) is a comma-separated list of storage class settings.

The valid storage class settings are

• Auto
• ExportedGlobal
• ImportedExtern
• ImportedExternPointer

• set_param(gcs,'TunableVarsTypeQualifier',str)

The argument str (character vector) is a comma-separated list of storage type qualifiers.

The following example declares the variable k1 to be tunable, with storage class ExportedGlobal
and type qualifier const. The number of variables and number of specified storage class settings
must match. If you specify multiple variables and storage class settings, separate them with a comma.

set_param(gcs,'TunableVars','k1')
set_param(gcs,'TunableVarsStorageClass','ExportedGlobal')
set_param(gcs,'TunableVarsTypeQualifier','const')
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Share Data Between Code Generated from Simulink, Stateflow,
and MATLAB

Stateflow and MATLAB Coder can fully define their data definitions, or they can inherit them from
Simulink. Data definition capabilities include:

• Inheriting input/output data types and sizes from Simulink.
• Parameterized data types and sizes. That is, data type and size may be specified as a function of

another data's type and size, e.g., type(y)=type(u) and size(y)=size(u).
• Inferred output size and type from Simulink via signal attribute back propagation.
• Parameter scoped data, which allows referencing Simulink parameters in Stateflow and MATLAB.

Open Example Model

Open the example model rtwdemo_dynamicio.

open_system('rtwdemo_dynamicio')

Instructions

1 Compile the model (on the Simulation tab, under Prepare, click Update Model) and note the
displayed signal types and sizes.

2 Change the data type and/or size of the Constant block and recompile the model. Note that the
attributes of the signals automatically adapt to the Constant block specification.

3 Generate and inspect code using the blue buttons in the model. Note that K is shared by the Gain
and sfVerticalSum block.

Notes

• The data type and size of Stateflow and MATLAB data is inherited from Simulink.
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• The Gain block and the Stateflow chart sfVerticalSum share the Simulink parameter K, which is
defined in the MATLAB workspace as a Simulink.Parameter with Model default storage class
(i.e., rtP.K in the generated code).
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Air-Fuel Ratio Control System with Fixed-Point Data
This example shows how to generate and optimize the code for a fixed-point air-fuel ratio control
system designed with Simulink® and Stateflow®. For a detailed explanation of the model, see:

• “Modeling a Fault-Tolerant Fuel Control System”
• “Fixed-Point Fuel Rate Control System” (Fixed-Point Designer)

The example uses the Embedded Coder® system target file (ert.tlc).

Relevant Portions of the Model

Figures 1-4 show relevant portions of the sldemo_fuelsys model, which is a closed-loop system
containing a plant subsystem and a controller subsystem. The plant allows engineers to validate the
controller through simulation early in the design cycle. In this example, generate code for the
relevant controller subsystem, fuel_rate_control. Figure 1 shows the top-level simulation model.

% Open |sldemo_fuelsys|, set the parameters and update the model diagram
% to view the signal data types.
close_system('sldemo_fuelsys',0)
load_system('sldemo_fuelsys');
rtwconfiguredemo('sldemo_fuelsys','ERT','fixed');
sldemo_fuelsys_data('sldemo_fuelsys','switch_data_type','fixed');
sldemo_fuelsys_data('sldemo_fuelsys','set_info_text','rtwdemo_fuelsys_fxp_script');
sldemo_fuelsys_data('sldemo_fuelsys','top_level_logging','on');
set_param('sldemo_fuelsys','ShowPortDataTypes','on');
set_param('sldemo_fuelsys','SampleTimeColors','on');
set_param('sldemo_fuelsys','Dirty','off');
sldemo_fuelsys([],[],[],'compile');
sldemo_fuelsys([],[],[],'term');
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Figure 1: Top-level model of the plant and controller

The air-fuel ratio control system is composed of Simulink® and Stateflow® blocks. It is the portion of
the model for which to generate code.

open_system('sldemo_fuelsys/fuel_rate_control');

Figure 2: The air-fuel ratio controller subsystem

The intake airflow estimation and closed loop correction system contains two lookup tables, Pumping
Constant and Ramp Rate Ki.

open_system('sldemo_fuelsys/fuel_rate_control/airflow_calc');
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Figure 3: The airflow_calc subsystem

The control logic is a Stateflow® chart that specifies the different modes of operation.

open_system('sldemo_fuelsys/fuel_rate_control/control_logic');

Figure 4: Fuel ratio controller logic

Remove the window clutter.

close_system('sldemo_fuelsys/fuel_rate_control/airflow_calc');
close_system('sldemo_fuelsys/fuel_rate_control/fuel_calc');
close_system('sldemo_fuelsys/fuel_rate_control/control_logic');
hDemo.rt=sfroot;hDemo.m=hDemo.rt.find('-isa','Simulink.BlockDiagram');
hDemo.c=hDemo.m.find('-isa','Stateflow.Chart','-and','Name','control_logic');
hDemo.c.visible=false;
close_system('sldemo_fuelsys/fuel_rate_control');

Build the air-fuel ratio control system only. Once the code generation process is complete, an HTML
report detailing the generated code is displayed. The main body of the code is located in
fuel_rate_control.c.

rtwbuild('sldemo_fuelsys/fuel_rate_control');

### Starting build procedure for: fuel_rate_control
### Successful completion of build procedure for: fuel_rate_control
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Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                                    
==================================================================================================
fuel_rate_control  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 25.695s

Figure 5 shows snippets of the generated code for the lookup table Pumping Constant.

To see the code for Pumping Constant, right-click the block and select C/C++ Code > Navigate To
C/C++ Code.

rtwtrace('sldemo_fuelsys/fuel_rate_control/airflow_calc/Pumping Constant');

The code for the pumping constant contains two breakpoint searches and a 2D interpolation. The
SpeedVect breakpoint is unevenly spaced, and while the PressVect breakpoint is evenly spaced,
neither have power of two spacing. The current spacing leads to extra code (ROM), including a
division, and requires all breakpoints to be in memory (RAM).
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Figure 5: Generated code for Pumping Constant lookup (contains unevenly spaced
breakpoints)

Optimize Code with Evenly Spaced Power of Two Breakpoints

You can optimize the generated code performance by using evenly spaced power of two breakpoints.
In this example, remap the lookup table data in the air-fuel ratio control system based on the existing
measured data.

When you loaded the model, the model PostLoadFcn created the lookup table data in the model
workspace. Retrieve the original table data via sldemo_fuelsys_data, modify it for evenly spaced
power of two, and reassign it in the model workspace.

td = sldemo_fuelsys_data('sldemo_fuelsys', 'get_table_data');

Compute new table data for evenly spaced power of two breakpoints.

ntd.SpeedVect   = 64 : 2^5 : 640;             % 32 rad/sec
ntd.PressVect   = 2*2^-5 : 2^-5 : 1-(2*2^-5); % 0.03 bar
ntd.ThrotVect   = 0:2^1:88;                   % 2 deg
ntd.RampRateKiX = 128:2^7:640;                % 128 rad/sec
ntd.RampRateKiY = 0:2^-2:1;                   % 0.25 bar

Remap table data.

 Air-Fuel Ratio Control System with Fixed-Point Data

34-207



ntd.PumpCon  = interp2(td.PressVect,td.SpeedVect,td.PumpCon, ntd.PressVect',ntd.SpeedVect);
ntd.PressEst = interp2(td.ThrotVect,td.SpeedVect,td.PressEst,ntd.ThrotVect',ntd.SpeedVect);
ntd.SpeedEst = interp2(td.PressVect,td.ThrotVect,td.SpeedEst,ntd.PressVect',ntd.ThrotVect);
ntd.ThrotEst = interp2(td.PressVect,td.SpeedVect,td.ThrotEst,ntd.PressVect',ntd.SpeedVect);

Recompute Ramp Rate table data.

ntd.RampRateKiZ = (1:length(ntd.RampRateKiX))' * (1:length(ntd.RampRateKiY)) * td.Ki;

Pumping Constant Power Of Two Spacing

figure('Tag','CloseMe');
mesh(td.PressVect,td.SpeedVect,td.PumpCon), hold on
mesh(ntd.PressVect,ntd.SpeedVect,ntd.PumpCon)
xlabel('PressVect'), ylabel('SpeedVect'), zlabel('PumpCon')
title(sprintf('Pumping Constant\nOriginal Spacing (%dx%d) vs. Power of Two Spacing (%dx%d)',...
    size(td.PumpCon,1),size(td.PumpCon,2),size(ntd.PumpCon,1),size(ntd.PumpCon,2)));

Pressure Estimate Power Of Two Spacing

clf
mesh(td.ThrotVect,td.SpeedVect,td.PressEst), hold on
mesh(ntd.ThrotVect,ntd.SpeedVect,ntd.PressEst)
xlabel('ThrotVect'), ylabel('SpeedVect'), zlabel('PressEst')
title(sprintf('Pressure Estimate\nOriginal Spacing (%dx%d) vs. Power of Two Spacing (%dx%d)',...
    size(td.PressEst,1),size(td.PressEst,2),size(ntd.PressEst,1),size(ntd.PressEst,2)));
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Speed Estimate Power Of Two Spacing

clf
mesh(td.PressVect,td.ThrotVect,td.SpeedEst), hold on,
mesh(ntd.PressVect,ntd.ThrotVect,ntd.SpeedEst)
xlabel('PressVect'), ylabel('ThrotVect'), zlabel('SpeedEst')
title(sprintf('Speed Estimate\nOriginal Spacing (%dx%d) vs. Power of Two Spacing (%dx%d)',...
    size(td.SpeedEst,1),size(td.SpeedEst,2),size(ntd.SpeedEst,1),size(ntd.SpeedEst,2)));
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Throttle Estimate Power Of Two Spacing

clf
mesh(td.PressVect,td.SpeedVect,td.ThrotEst), hold on
mesh(ntd.PressVect,ntd.SpeedVect,ntd.ThrotEst)
xlabel('PressVect'), ylabel('SpeedVect'), zlabel('ThrotEst')
title(sprintf('Throttle Estimate\nOriginal Spacing (%dx%d) vs. Power of Two Spacing (%dx%d)',...
    size(td.ThrotEst,1),size(td.ThrotEst,2),size(ntd.ThrotEst,1),size(ntd.ThrotEst,2)));
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Ramp Rate Ki Power Of Two Spacing

clf
mesh(td.RampRateKiX,td.RampRateKiY,td.RampRateKiZ'), hold on
mesh(ntd.RampRateKiX,ntd.RampRateKiY,ntd.RampRateKiZ'), hidden off
xlabel('RampRateKiX'), ylabel('RampRateKiY'), zlabel('RampRateKiZ')
title(sprintf('Ramp Rate Ki\nOriginal Spacing (%dx%d) vs. Power of Two Spacing (%dx%d)',...
    size(td.RampRateKiZ,1),size(td.RampRateKiZ,2),size(ntd.RampRateKiZ,1),size(ntd.RampRateKiZ,2)));
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The default configuration causes the model to log simulation data for the top-level signals. These
simulation results are stored in the workspace variable sldemo_fuelsys_output. Before updating
the model workspace with the new data, save the result of the simulation in hDemo.orig_data for
later comparison with the evenly spaced power of two table simulation.

set_param('sldemo_fuelsys','StopTime','8')
sim('sldemo_fuelsys')
hDemo.orig_data = sldemo_fuelsys_output;

Reassign the new table data in the model workspace.

hDemo.hWS = get_param('sldemo_fuelsys', 'ModelWorkspace');
hDemo.hWS.assignin('PressEst',   ntd.PressEst);
hDemo.hWS.assignin('PressVect',  ntd.PressVect);
hDemo.hWS.assignin('PumpCon',    ntd.PumpCon);
hDemo.hWS.assignin('SpeedEst',   ntd.SpeedEst);
hDemo.hWS.assignin('SpeedVect',  ntd.SpeedVect);
hDemo.hWS.assignin('ThrotEst',   ntd.ThrotEst);
hDemo.hWS.assignin('ThrotVect',  ntd.ThrotVect);
hDemo.hWS.assignin('RampRateKiX',ntd.RampRateKiX);
hDemo.hWS.assignin('RampRateKiY',ntd.RampRateKiY);
hDemo.hWS.assignin('RampRateKiZ',ntd.RampRateKiZ);

Reconfigure lookup tables for evenly spaced data.

hDemo.lookupTables = find_system(get_param('sldemo_fuelsys','Handle'),...
    'BlockType','Lookup_n-D');
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for hDemo_blkIdx = 1 : length(hDemo.lookupTables)
    hDemo.blkH = hDemo.lookupTables(hDemo_blkIdx);
    set_param(hDemo.blkH,'IndexSearchMethod','Evenly spaced points')
    set_param(hDemo.blkH,'InterpMethod','None - Flat')
    set_param(hDemo.blkH,'ProcessOutOfRangeInput','None')
end

Rerun the simulation for the evenly spaced power of two implementation, and store the result of the
simulation in hDemo.pow2_data.

sim('sldemo_fuelsys')
hDemo.pow2_data = sldemo_fuelsys_output;

Compare the result of the simulation for the fuel flow rate and the air fuel ratio. The simulation
exercised the Pumping Constant and Ramp Rate Ki lookup tables, and shows an excellent match for
the evenly spaced power of two breakpoints relative to the original table data.

figure('Tag','CloseMe');
subplot(2,1,1);
plot(hDemo.orig_data.get('fuel').Values.Time, ...
     hDemo.orig_data.get('fuel').Values.Data,'r-');
hold
plot(hDemo.pow2_data.get('fuel').Values.Time, ...
     hDemo.pow2_data.get('fuel').Values.Data,'b-');
ylabel('FuelFlowRate (g/sec)');
title('Fuel Control System: Table Data Comparison');
legend('original','even power of two');
axis([0 8 .75 2.25]);
subplot(2,1,2);
plot(hDemo.orig_data.get('air_fuel_ratio').Values.Time, ...
     hDemo.orig_data.get('air_fuel_ratio').Values.Data,'r-');
hold
plot(hDemo.pow2_data.get('air_fuel_ratio').Values.Time, ...
     hDemo.pow2_data.get('air_fuel_ratio').Values.Data,'b-');
ylabel('Air/Fuel Ratio');
xlabel('Time (sec)');
legend('original','even power of 2','Location','SouthEast');
axis([0 8 11 16]);

Current plot held
Current plot held
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Rebuild the air-fuel ratio control system and compare the difference in the generated lookup table
code.

rtwbuild('sldemo_fuelsys/fuel_rate_control');

### Starting build procedure for: fuel_rate_control
### Successful completion of build procedure for: fuel_rate_control

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                   
=================================================================================
fuel_rate_control  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 23.828s

Figure 6 shows the same snippets of the generated code for the 'Pumping Constant' lookup table. The
generated code for evenly spaced power of two breakpoints is significantly more efficient than the
unevenly spaced breakpoint case. The code consists of two simple breakpoint calculations and a
direct index into the 2D lookup table data. The expensive division is avoided and the breakpoint data
is not required in memory.

rtwtrace('sldemo_fuelsys/fuel_rate_control/airflow_calc/Pumping Constant');
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Figure 6: Generated code for Pumping Constant lookup (evenly spaced power of two
breakpoints)

Close the example.
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close(findobj(0,'Tag','CloseMe'));
clear hDemo* td ntd
close_system('sldemo_fuelsys',0);
rtwdemoclean;

Model Advisor for Code Efficiency

Improving code efficiency by using evenly spaced power of two breakpoints is one of several
important optimizations for fixed-point code generation. The Simulink® Model Advisor is a great tool
for identifying other methods of improving code efficiency for a Simulink® and Stateflow® model.
Make sure to run the checks under the Embedded Coder® folder or Simulink Coder®.

Related Examples

• Fixed-point design: “Fixed-Point Fuel Rate Control System” (Fixed-Point Designer)
• Production C/C++ code generation: “Air-Fuel Ratio Control System with Stateflow Charts” on

page 12-10

See Also

Related Examples
• “Optimize Speed and Size of Signal Processing Algorithm by Using Fixed-Point Data” on page

34-194
• “Optimize Generated Code Using Fixed-Point Data with Simulink®, Stateflow®, and MATLAB®”

on page 34-195
• “Fixed-Point Code Generation Support” (Fixed-Point Designer)
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Data Definition and Declaration
Management in Embedded Coder

• “Control Placement of Global Data Definitions and Declarations in Generated Files”
on page 35-2

• “Establish Data Ownership in a Model Hierarchy” on page 35-10
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Control Placement of Global Data Definitions and Declarations
in Generated Files

The generated code can create standard, global structure variables whose fields represent the signal,
state, and parameter data in a model. With storage classes, you can configure data to appear in the
code as separate global variables or custom global structures. For information about the standard
data structures, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on
page 34-49 and “How Generated Code Exchanges Data with an Environment” on page 34-35. For
information about storage classes, see “Choose Storage Class for Controlling Data Representation in
Generated Code” on page 34-74.

You can control the file placement of the variable definitions and declarations. Use the information in
the table.

Goal Details and Techniques
Generate a variable that external code can use Apply a storage class with exported data scope,

such as ExportToFile. The generated code
declares the variable in a file that your code can
include (#include).

To generate an extern declaration in model.h,
consider using the storage class
ExportedGlobal.

Alternatively, to place the declaration in a file
whose name you can specify, choose one of these
techniques:

• To aggregate multiple variable declarations
into one or more specific header files by
default, apply a storage class such as
ExportToFile to a category of data by using
the Code Mappings editor. As you add blocks
and signals to the model, new data items are
declared in the files that you specify.

• To explicitly specify the placement for an
individual data item, directly apply a storage
class such as ExportToFile and specify a
header file name by using the Header file
property.

See “Exchange Data Between External Calling
Code and Generated Code” on page 56-77.
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Goal Details and Techniques
Generate code that uses a variable defined by
external code

Apply a storage class with imported data scope,
such as ImportFromFile, to a data element in a
model that represents the variable. Then, the
generated code does not define the variable, but
instead includes (#include) an external header
file whose name you can specify. The generated
algorithm (for example, the model step function)
reads and writes to the variable.

Alternatively, if you do not have an external
declaration header file or do not want the
generated code to include a header file, apply the
storage class ImportedExtern. Then, the
generated code declares the variable in
model_private.h.

See “Exchange Data Between External Calling
Code and Generated Code” on page 56-77.

• Reduce the size of a generated file by creating
multiple smaller files

• Organize data into different files to make
generated code easier to understand

Depending on the setting of Configuration
Parameters > File packaging format,
generated files such as model.c and
model_data.c can contain many definitions of
global variables. Corresponding header files can
contain many declarations.

• To make model.c smaller, consider setting
File packaging format to Modular or
Compact (with separate data file).
Then, the generated code defines the standard
structures that represent tunable and
constant parameter data in model_data.c
instead of model.c.

• To place different categories of data (for
example, external parameters, block states,
and internal signals) in specific files by
default, use the Code Mappings editor. For
each category of data, use a storage class
such as ExportToFile and specify the
property Header file. See “Configure Default
Code Generation for Data” on page 33-16.

• For precise control over the file placement of
data, apply storage classes such as
ExportToFile to individual data items. Use
the properties of the storage class, such as
Definition file and Header file, to specify file
placement for each data item. For an example,
see “Definition and Declaration of Signal
Data” on page 25-7.
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Goal Details and Techniques
Combine multiple files into a single file • Consider setting the model configuration

parameter File packaging format to
Compact. Then, the code generator does not
create the model_data.c file. Instead, the
definitions of the standard structures that
store tunable and constant parameter data
appear in model.c.

• When you apply a storage class such as
ExportToFile to data elements, leave the
properties Definition file and Header file
blank, the default value. Also, set the model
configuration parameter Data definition to
Data defined in source file. Then, the
data definitions appear in model.c with the
definitions of other global data.

Separate data definitions from function
definitions

By default, the generated file that defines the
entry-point functions for a model or subsystem
also defines the data for that model or subsystem.
When you frequently make changes to data,
especially initial values for tunable parameters,
the changing source code files can impede
verification and make change management more
difficult. To separate the data from the functions:

• Consider setting the model configuration
parameter File packaging format to a value
that results in the generation of the separate
data file model_data.c. Then, the definitions
of the standard structures that store tunable
and constant parameter data appear in this
file instead of in model.c.

• Apply storage classes such as ExportToFile
to data elements by using the Code Mappings
editor. Use the properties of the storage class,
such as Definition file and Header file, to
specify file placement. For more information,
see “Configure Default Code Generation for
Data” on page 33-16 and “Organize Parameter
Data into a Structure by Using Struct Storage
Class” on page 33-68.

Isolate data definitions in separate files for
component-based, team-oriented model
development

See “Organize Data to Support Component-
Based, Team-Oriented Model Development” on
page 35-5.
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Goal Details and Techniques
Aggregate definitions of variant control
parameters (#define macros) into a single
header file

As described in “Generate Preprocessor
Conditionals for Variant Systems” on page 26-31,
a variant control parameter is a parameter object
such as Simulink.Parameter. You apply a
storage class that makes the object appear in the
generated code as a macro. To control the file
placement, choose one of these techniques:

• For each variant control parameter that uses
the storage class Define, set the Header file
property to the same value. To configure these
objects in a list that you can search, sort, and
filter, you can use the Model Data Editor
Parameters tab. For an example, see
“Generate Variant Control Macros in Same
Header File” on page 26-33.

• Create one or more storage classes that
represent variant control parameters. In the
Custom Storage Class Designer, you can set
Header file to a value that applies to all of
the variant control parameters that use the
storage class. With this technique, you do not
need to manually specify a header file for each
variant control parameter. For more
information, see “Create Storage Classes by
Using the Custom Storage Class Designer” on
page 38-15.

Organize Data to Support Component-Based, Team-Oriented Model
Development
Depending on your model configuration, data definitions can appear aggregated in large generated
files. In a system of components (subsystems or referenced models), you can separate and organize
the data definitions into manageable, meaningful files based on the component hierarchy.
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Goal Technique
Establish ownership of global data by placing the
data definitions with the code generated for
specific components

When you divide a system into components by
using referenced models and atomic subsystems,
by default, global data is typically defined by the
code generated for the top component in the
hierarchy. Global data includes parameters,
signals, and states to which you apply storage
classes (see “C Code Generation Configuration
for Model Interface Elements” on page 33-2).

Instead, you can place global data definitions
with other components in the hierarchy. For an
example involving referenced models, see
“Establish Data Ownership in a Model Hierarchy”
on page 35-10.

• To place a data definition with the code
generated for a referenced model, use a built-
in storage class such as ExportToFile, or a
storage class that you create in a package,
and set the Owner property to the name of
the referenced model.

To use Owner in a model, you must select the
model configuration parameter Use owner
from data object for data definition
placement. The default setting for this
parameter, cleared, means the code generator
ignores the setting that you specify for
Owner.

If only one referenced model uses a parameter
object, consider storing the object in the
model workspace of that model. Then, the
code generated for that model defines the
data. You do not need to specify an owner
(Owner) for the object.

• In an atomic subsystem, use a storage class
such as ExportToFile and explicitly specify
the name of the definition file by using the
Definition file property. However, you cannot
place the definition file with the source files
that belong to the subsystem. Instead, the
definition file that you specify appears in the
folder generated for the model.
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Goal Technique
For an atomic subsystem, place the standard data
structures for the subsystem with the subsystem
code

By default, the standard data structures for an
atomic subsystem appear as substructures of the
data structures for the entire model.

To generate separate data structures for a
subsystem, select the Function with separate
data parameter in the subsystem block. Then, the
subsystem data appear in separate structure
variables that the subsystem code defines. See
“Generate Modular Function Code for Nonvirtual
Subsystems” on page 41-2.

Specify Default Placement
When you create data in a model by adding blocks and signal lines, by default, the data definitions
appear in model.c. To specify a different default placement, use these tools and parameters:

• The model configuration parameter File packaging format. The setting that you choose
determines whether the code generator places the standard structures that store tunable and
constant parameter data in model_data.c instead of model.c. See “File packaging format”.

• The Code Mappings editor. For each category of model data, you can specify a default storage
class, which controls file placement. For example, apply the storage class ExportToFile to a
data category and, in the Property Inspector, use the DefinitionFile, HeaderFile, and Owner
properties to control file placement.

• The model configuration parameters Data definition and Data declaration. These configuration
parameters specify the default file placement for data items that you apply storage classes to.

• These configuration parameters do not affect data items that you apply these storage classes
to:

• ExportedGlobal
• ImportedExtern
• ImportedExternPointer
• BitField
• FileScope
• Localizable
• Struct
• CompilerFlag

In the Embedded Coder Dictionary, the Header File value for unsupported storage classes is
empty. You cannot specify default file placement for unsupported storage classes.

• If you apply a storage class that explicitly specifies definition and declaration files for a data
element, those specifications override the Data definition and Data declaration
configuration parameters.

For more information, see “Data definition” and “Data declaration”.
• The subsystem block parameter Function with separate data. When you select this parameter,

the standard structures that store the subsystem data, such as the DWork structure, appear as
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separate structure variables. By default, the variable definitions appear in the source file that
defines the subsystem execution function. See “Generate Modular Function Code for Nonvirtual
Subsystems” on page 41-2.

Override Default Placement for Individual Data Items
For an individual data item, to override the default file placement, use the Code Mappins editor to
apply a storage class directly. For example, to make a data item appear in the generated code as a
global variable, apply the storage class ExportToFile. Then, use the Definition file and Header
file properties to control file placement. To apply storage classes directly, see “Organize Parameter
Data into a Structure by Using Struct Storage Class” on page 33-68.

Prevent Name Clashes by Configuring Data Item as static
To apply the C keyword static to a global variable, which can help you avoid name clashes by
limiting the scope of the variable name to the file that defines the variable, choose one of these
techniques:

• Apply the built-in storage class FileScope. For more information, see “Choose Storage Class for
Controlling Data Representation in Generated Code” on page 34-74.

• If FileScope does not satisfy your requirements, create your own storage class by using the
Custom Storage Class Designer. In the Designer, set Data scope to File or Auto.

• With File, the data element appears in the code as a static global variable.

• With Auto, the code generator first attempts to represent the data element with a local
variable in a function. If this attempt fails, the code generator uses a static global variable.

For an example that shows how to create your own storage class by using the Designer, see
“Create and Apply a Storage Class” on page 38-15.

You cannot apply static to the standard data structures such as the DWork structure.

To access static data, you can configure the generated code to include an interface such as an a2l
(ASAP2) file. For more information, see “Export ASAP2 File for Data Measurement and Calibration”
on page 61-2. To place the data in a specific memory location by including pragmas or other
decorations in the generated code, create your own memory section and storage class. See “Control
Data and Function Placement in Memory by Inserting Pragmas” on page 43-2.

Code Generation Impact of Storage Location for Parameter Objects
You can create a parameter object (such as Simulink.Parameter) in the base workspace, a model
workspace, or a data dictionary. However, when you apply a storage class to the object, the location
of the object can impact the file placement of the corresponding data definition in the generated
code. See “Code Generation Impact of Storage Location for Parameter Objects” on page 34-116.

Specify Default #include Syntax for Data Header Files
To control the file placement of a data item, such as a signal line or block state, in the generated
code, you can apply a storage class to the data item (see “Organize Parameter Data into a Structure
by Using Struct Storage Class” on page 33-68). You then use the Header file property to specify the
generated or external header file that contains the declaration of the data.
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To reduce maintenance effort and data entry, when you specify Header file, you can omit delimiters
(" or <>) and use only the file name. You can then control the default delimiters that the generated
code uses for the corresponding #include directives. To use angle brackets by default, set
Configuration Parameters > Code Generation > Code Placement > #include file delimiters to
#include <header.h>.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Component-Based Modeling”
• “Manage File Packaging of Generated Code Modules” on page 51-12
• “How Generated Code Exchanges Data with an Environment” on page 34-35
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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Establish Data Ownership in a Model Hierarchy
This example shows how to establish ownership of global data in the code generated from referenced
models.

You can create a global variable in the generated code by applying a storage class to a data element
in a referenced model (see “C Code Generation Configuration for Model Interface Elements” on page
33-2). Under certain conditions, the code generator places the variable definition with the code
generated from the top model in the hierarchy. This default placement can make it more difficult to
determine which model is responsible for the data and to manage code changes in a team-based
development environment.

To establish ownership of a global variable by placing the definition with the code generated from the
relevant model, apply a storage class such as ExportToFile and specify the Owner custom
attribute. Alternatively, for parameter objects such as Simulink.Parameter that you use in only
one model, you can establish ownership by storing the object in a model workspace instead of the
base workspace or a data dictionary.

Explore Example Model

1. Copy the script file prepare_sldemo_fuelsys_dd_ctrl.m to your current folder.

[~, ~] = copyfile(fullfile(matlabroot,'examples','ecoder','main','prepare_sldemo_fuelsys_dd_ctrl.m'),...
    'prepare_sldemo_fuelsys_dd_ctrl.m','f');

2. Run the copy of the script in your current folder. The script opens the model
sldemo_fuelsys_dd_controller and prepares it for this example.

prepare_sldemo_fuelsys_dd_ctrl
open_system('sldemo_fuelsys_dd_controller')

This controller model contains two models, airflow_calc and fuel_calc. The two outputs of
airflow_calc, est_airflow and fb_correction, are inputs of fuel_calc.

3. Open the airflow_calc model.

35 Data Definition and Declaration Management in Embedded Coder

35-10



open_system('airflow_calc')

4. On the Modeling tab, click Model Data Editor.

5. In the Model Data Editor, set the Change view drop-down list to Code.

6. In the airflow_calc model, select the est_airflow Outport block.

7. In the Model Data Editor, inspect the value in the Storage Class column. The signal that this block
represents, est_airflow, uses the storage class ExportToFile. With this setting, the signal
appears in the generated code as a global variable. The Outport block labeled fb_correction also
uses this setting.

8. In the Model Data Editor, select the Parameters tab and click the Show/refresh additional
information button. The Model Data Editor now shows information about workspace variables and
objects, such as Simulink.Parameter objects, that the model uses to set block parameter values.

9. In the Filter contents box, enter numerator. The Simulink.Parameter object
numerator_param, which is in the base workspace, sets the value of the Numerator parameter in
the Discrete Filter block labeled Throttle Transient. The object uses the storage class
ExportToFile.

10. Select the Signals tab. In the Filter contents box, enter e0. The signal e0, which is internal to
the airflow_calc referenced model, also uses ExportToFile. The signal is internal because it is
not a root-level input or output of the model.

11. Open the fuel_calc model.

open_system('fuel_calc')
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12. In the Model Data Editor for this model, on the Inports/Outports tab, set Change view to Code.
The Inport blocks est_airflow and fb_correction use the same storage class, ExportToFile,
as the corresponding Outport blocks in airflow_calc. The Outport block labeled fuel_rate also
uses ExportToFile.

Generate and Inspect Code

Generate code from the controller model, sldemo_fuelsys_dd_controller.

evalc('slbuild(''sldemo_fuelsys_dd_controller'')');

In the code generation report, under Referenced Models, click the hyperlink to inspect the code
generated for airflow_calc.

The file airflow_calc.c defines the global variable that represents the signal e0. Because the
blocks that write to and read from e0 exist only in airflow_calc, the code generator assumes that
this model owns the signal.

file = fullfile('slprj','ert','airflow_calc','airflow_calc.c');
rtwdemodbtype(file,'/* Definition for custom storage class: ExportToFile */',...
    'real32_T e0;',1,1)

/* Definition for custom storage class: ExportToFile */
real32_T e0;                           /* '<Root>/Sum1' */

In the code generation report, return to the code generated for sldemo_fuelsys_dd_controller.

The file sldemo_fuelsys_dd_controller.c defines the other global variables.

file = fullfile('sldemo_fuelsys_dd_controller_ert_rtw',...
    'sldemo_fuelsys_dd_controller.c');
rtwdemodbtype(file,...
    '/* Definition for custom storage class: ExportToFile */',...
    'real32_T numerator_param[2] = { 0.01F, -0.01F } ;',1,1);
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/* Definition for custom storage class: ExportToFile */
real32_T est_airflow;                  /* '<Root>/airflow_calc' */
real32_T fb_correction;                /* '<Root>/airflow_calc' */
real32_T fuel_rate;                    /* '<Root>/fuel_calc' */
real32_T numerator_param[2] = { 0.01F, -0.01F } ;

Because the signals est_airflow and fb_correction pass between the two models and through
the top-level controller model, the code generator assumes that sldemo_fuelsys_dd_controller
owns the signals. The code generator makes a similar assumption about fuel_rate. Because the
parameter object numerator_param exists in the base workspace, any model in the hierarchy can
use the object. Therefore, the code generator assumes that sldemo_fuelsys_dd_controller
owns the parameter.

You can configure each shared signal and the parameter object so that the corresponding variable
definition appears in the code generated for the relevant model.

Configure Data Ownership

In this example, you configure code generation settings so that:

• The code generated for the airflow_calc model defines the signals that pass between the two
models, est_airflow and fb_correction.

• The code generated for airflow_calc defines the parameter data, numerator_param.
• The code generated for fuel_calc defines the output signal that it calculates, fuel_rate.

1. In the airflow_calc model, on the Modeling tab, under Design, click Property Inspector.

2. In the Model Data Editor, select the Inports/Outports tab.

3. Select the row that corresponds to the Outport block est_airflow. The Property Inspector shows
the properties of the Outport block.

4. In the Property Inspector, under Code, set Owner to airflow_calc. The code generator places
the definition of the global variable with the code generated for airflow_calc.

5. For fb_correction, use the Model Data Editor and the Property Inspector to set Owner to
airflow_calc.

6. Select the Parameters tab.

7. Find the row that corresponds to the parameter object, numerator_param. In the row, double-
click the icon in the left column. The Model Explorer opens and displays the properties of
numerator_param.

8. In the Model Hierarchy pane, expand the airflow_calc node so that you can see the subordinate
Model Workspace node.

9. Use the Model Explorer to move numerator_param from the base workspace to the
airflow_calc model workspace. For example, in the Model Hierarchy pane, select Base
Workspace. Then, drag numerator_param from the Contents pane to the Model Workspace node
in the Model Hierarchy pane. With this change, the code generator assumes that airflow_calc
owns numerator_param, and places the variable definition in the code generated for
airflow_calc.
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10. In the fuel_calc model, on the Modeling tab, under Design, click Property Inspector.

11. For the Inport blocks est_airflow and fb_correction, use the Model Data Editor and the
Property Inspector to set Owner to airflow_calc. With this configuration, the fuel_calc code
does not define the variables.

12. For the Outport block, use the Model Data Editor and the Property Inspector to set Owner to
fuel_calc.

Alternatively, to configure the data in the models, use these commands at the command prompt:

temp = Simulink.Signal;
temp.CoderInfo.StorageClass = 'Custom';
temp.CoderInfo.CustomStorageClass = 'ExportToFile';
temp.CoderInfo.CustomAttributes.Owner = 'airflow_calc';

set_param('airflow_calc/est_airflow','SignalName','est_airflow')
set_param('airflow_calc/est_airflow','SignalObject',copy(temp))

set_param('airflow_calc/fb_correction','SignalName','fb_correction')
set_param('airflow_calc/fb_correction','SignalObject',copy(temp))

mdlwks = get_param('airflow_calc','ModelWorkspace');
assignin(mdlwks,'numerator_param',copy(numerator_param));

portHandles = get_param('fuel_calc/est_airflow','portHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle,'Name','est_airflow')
set_param(outportHandle,'SignalObject',copy(temp))

portHandles = get_param('fuel_calc/fb_correction','portHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle,'Name','fb_correction')
set_param(outportHandle,'SignalObject',copy(temp))

temp.CoderInfo.CustomAttributes.Owner = 'fuel_calc';

set_param('fuel_calc/fuel_rate','SignalName','fuel_rate')
set_param('fuel_calc/fuel_rate','SignalObject',copy(temp))

clear temp portHandles outportHandle numerator_param

13. In each of the three models, select Configuration Parameters > Use owner from data object
for data definition placement. With this setting cleared (the default), the code generator ignores
the values that you specify for Owner.

set_param('fuel_calc','EnableDataOwnership','on')
set_param('airflow_calc','EnableDataOwnership','on')
set_param('sldemo_fuelsys_dd_controller','EnableDataOwnership','on')

14. Save the referenced models.

save_system('fuel_calc')
save_system('airflow_calc')

Generate Improved Code

Generate code from the controller model, sldemo_fuelsys_dd_controller.
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evalc('slbuild(''sldemo_fuelsys_dd_controller'')');

Now, the file sldemo_fuelsys_dd_controller.c does not define any of the global variables.

In the code generation report, inspect the code generated for airflow_calc.

The file airflow_calc.c now defines the global variables that belong to airflow_calc.

file = fullfile('slprj','ert','airflow_calc','airflow_calc.c');
rtwdemodbtype(file,'/* Definition for custom storage class: ExportToFile */',...
    'real32_T numerator_param[2] = { 0.01F, -0.01F } ;',1,1)

/* Definition for custom storage class: ExportToFile */
real32_T e0;                           /* '<Root>/Sum1' */
real32_T est_airflow;                  /* '<Root>/Sum' */
real32_T fb_correction;                /* '<Root>/Discrete Integrator' */
real32_T numerator_param[2] = { 0.01F, -0.01F } ;

Inspect the code generated for fuel_calc. The file fuel_calc.c defines the global variable
fuel_rate.

file = fullfile('slprj','ert','fuel_calc','fuel_calc.c');
rtwdemodbtype(file,'/* Definition for custom storage class: ExportToFile */',...
    'real32_T fuel_rate;',1,1)

/* Definition for custom storage class: ExportToFile */
real32_T fuel_rate;                    /* '<S2>/Merge' */

Create Single Point of Specification for Signals That Pass Between Models

The signal data elements est_airflow and fb_correction are represented by Outport blocks in
airflow_calc and by Inport blocks in fuel_calc. If you want to change the configuration of one of
these signals, you must make the change in both models. For example, if you want to change the
storage class of est_airflow from ExportToFile to Volatile, you must change the storage class
twice: once for the Outport block in airflow_calc and again for the Inport block in fuel_calc.

To make maintenance of each signal easier, store the code generation settings in a
Simulink.Signal object, which can exist in the base workspace or a data dictionary.

1. In the Model Data Editor for airflow_calc, on the Inports/Outports tab, find the row that
corresponds to est_airflow. For that row, in the Signal Name column, click the cell.

2. In the cell, next to the est_airflow text, click the action button (with three vertical dots). Select
Create and Resolve.

3. In the Create New Data dialog box, set Value to Simulink.Signal and click Create. A
Simulink.Signal object named est_airflow appears in the base workspace. In the Model Data
Editor, for est_airflow, the check box in the Resolve check box is selected, which means the
Outport block acquires code generation settings from the signal object in the base workspace.

4. In the est_airflow property dialog box, set Storage class to ExportToFile.

5. Set Owner to airflow_calc.

6. Use the Model Data Editor to create a similar signal object for fb_correction.
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In the Model Data Editor for fuel_calc, on the Inports/Outports tab, in the Resolve column,
select the check boxes for est_airflow and fb_correction. Now, each Inport block acquires code
generation settings from the corresponding signal object.

Alternatively, to create the signal object and configure the blocks and lines in the model, at the
command prompt, use these commands:

est_airflow = Simulink.Signal;
est_airflow.CoderInfo.StorageClass = 'Custom';
est_airflow.CoderInfo.CustomStorageClass = 'ExportToFile';
est_airflow.CoderInfo.CustomAttributes.Owner = 'airflow_calc';

fb_correction = Simulink.Signal;
fb_correction.CoderInfo.StorageClass = 'Custom';
fb_correction.CoderInfo.CustomStorageClass = 'ExportToFile';
fb_correction.CoderInfo.CustomAttributes.Owner = 'airflow_calc';

set_param('airflow_calc/est_airflow', 'StorageClass', 'Auto')
set_param('airflow_calc/est_airflow','MustResolveToSignalObject','on')

set_param('airflow_calc/fb_correction', 'StorageClass', 'Auto')
set_param('airflow_calc/fb_correction','MustResolveToSignalObject','on')

portHandles = get_param('fuel_calc/est_airflow','portHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle, 'StorageClass', 'Auto')
set_param(outportHandle,'MustResolveToSignalObject','on')

portHandles = get_param('fuel_calc/fb_correction','portHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle, 'StorageClass', 'Auto')
set_param(outportHandle,'MustResolveToSignalObject','on')

clear portHandles outportHandle

7. Save the models and generate code from sldemo_fuelsys_dd_controller. The code is the
same as it was before you created the Simulink.Signal objects. Now, you can make changes to the
signal objects instead of the corresponding blocks and lines in the models.

save_system('airflow_calc')
save_system('fuel_calc')
evalc('slbuild(''sldemo_fuelsys_dd_controller'')');

See Also

Related Examples
• “Control Placement of Global Data Definitions and Declarations in Generated Files” on page 35-

2
• “Generate Code for Model Reference Hierarchy” on page 5-2
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Data Types in Embedded Coder

• “Control Data Type Names in Generated Code” on page 36-2
• “Control File Placement of Custom Data Types” on page 36-19
• “Replace and Rename Data Types to Conform to Coding Standards” on page 36-22
• “Exchange Structured and Enumerated Data Between Generated and External Code”

on page 36-27
• “Specify Boolean and Data Type Limit Identifiers” on page 36-34
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Control Data Type Names in Generated Code
By default, the generated code uses Simulink Coder data type aliases to define scalar and array
variables. For example, the Simulink Coder type real32_T corresponds to the Simulink type single.
The code defines these types through typedef statements that build on C primitive types such as
float and short. You can configure the code to use custom type names instead.

The code also aggregates signal, block parameter, and state data into structures (see “How
Generated Code Exchanges Data with an Environment” on page 34-35 and “How Generated Code
Stores Internal Signal, State, and Parameter Data” on page 34-49) by default. You can specify a
naming rule for these structure types. You can also place data items into separate custom structures
whose type names you can control.

Control these type names to help you to:

• Conform to coding standards. For an example, see “Replace and Rename Data Types to Conform
to Coding Standards” on page 36-22.

• Integrate the generated code with your external code. For an example, see “Exchange Structured
and Enumerated Data Between Generated and External Code” on page 36-27.

• Make the generated code more readable and meaningful.

For custom types, you can also specify that the generated code reuse type definitions, for example,
typedef statements, from your external code.

For information about data type names that you cannot control and about custom data types that the
generated code does not support, see “Limitations” on page 36-17.

To inform the code generator about the bit length of generic C types such as int and short for your
target hardware, use Hardware Implementation configuration parameters. See “Configure Run-
Time Environment Options” on page 9-2.

Control Names of Primitive Data Types
To rename a Simulink Coder primitive data type such as int8_T, create a Simulink.AliasType
object whose name matches the type name that you want the generated code to use. For example, to
create a type named myType, at the command prompt, enter:

myType = Simulink.AliasType;

Set the BaseType property to the name of the Simulink data type that corresponds to the target
Simulink Coder data type. For example, if the target type is int8_T, specify int8. To identify the
Simulink data type, use the information in the table.

Simulink Coder Type Name Corresponding Simulink Type Name
real_T double
real32_T single
int32_T int32
int16_T int16
int8_T int8
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Simulink Coder Type Name Corresponding Simulink Type Name
uint32_T uint32
uint16_T uint16
uint8_T uint8
boolean_T boolean

For configuring data type replacement
throughout an entire model (Configuration
Parameters > Code Generation > Data Type
Replacement), you can alternatively use one of
these types:

• uint8
• int8
• intn*

int_T intn*
uint_T uintn*
char_T intn*
uint64_T uint64
int64_T int64

* Replace n with the number of bits displayed in Configuration Parameters > Hardware
Implementation for either Number of bits: int or Number of bits: char. Use the appropriate
number of bits for the data type that you want to rename.

Note The boolean_T BaseType must promote to a signed int.

For example, to replace the type name uint8_T with myType, set the BaseType property of the
Simulink.AliasType object to 'int8'.

myType.BaseType = 'int8';

Then, use one or both of these techniques to apply the type to data items in a model:

• Configure data type replacements. Throughout the code that you generate from a model, you can
replace a Simulink Coder data type name with the name of the Simulink.AliasType object. You
configure data type replacements through model configuration parameters (Configuration
Parameters > Code Generation > Data Type Replacement.

For an example that shows how to use data type replacement, see “Replace and Rename Data
Types to Conform to Coding Standards” on page 36-22.

• Use the name of the Simulink.AliasType object to specify the data type of an individual signal,
that is, a block output, or block parameter. By default, due to data type propagation and
inheritance (see “Data Type Inheritance Rules”), the signals, states, and parameters of other
downstream blocks typically inherit the same data type. Optionally, you can configure data items
in upstream blocks to inherit the type (Inherit: Inherit via back propagation) or stop
the propagation at an arbitrary block by specifying a noninherited data type setting.

 Control Data Type Names in Generated Code

36-3



To specify a data type for an individual data item, use the Model Data Editor (on the Modeling
tab, click Model Data Editor). You can use the name of the same Simulink.AliasType object
to specify the data types of multiple data items.

For an example that shows how to use a Simulink.AliasType object directly in a model, see
“Create Data Type Alias in the Generated Code” on page 36-9.

Control Names of Primitive Types Technique
Change the name of a primitive type that the
generated code uses to define variables by
default (for example, int8_T).

Configure a data type replacement for an entire
model.

To replace a default Simulink Coder data type
name with the corresponding Simulink type
name, for example, to replace int8_T with int8,
you do not need to create a
Simulink.AliasType object. See “Use
Simulink Data Type Names Instead of Simulink
Coder Data Type Names” on page 36-5.

To share data type replacements throughout a
model reference hierarchy, use referenced
configuration sets (see “Share a Configuration
Across Referenced Models”).

Configure the generated code to define a
particular data item, such as a variable, by using
a specific, meaningful type name.

In the model, locate the data item that
corresponds to the variable. For example, trace
from the code generation report to the model.
Use the name of the Simulink.AliasType
object to set the data type of the item.

If necessary, to prevent other data items in
upstream and downstream blocks from using the
same type name, configure those items to use a
data type setting that is not inherited. By default,
most signals use the inherited type Inherit:
Inherit via internal rule.

Use the same type name for multiple signals and
other data items in a data path, which is a series
of connected blocks.

In the model, use the name of a
Simulink.AliasType object to set the data
type of one of the signals in the path, for
example, a root-level Inport block or a Constant
block. For example, if the path begins with an
Inport block at the root level of the model, you
can specify the type in that block. By default, due
to data type propagation, the data items in the
other blocks typically inherit the same type.

Usually, no matter where on the data path you
specify the type, downstream data items inherit
the type. You can configure upstream data items
to inherit the type, too. Consider specifying the
type in a block that you do not expect to remove
or change frequently.
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Control Names of Primitive Types Technique
Configure the generated code to replace an
implementation-dependent type, such as char_T
or boolean_T, and another type of equivalent bit
length with a single type name that you specify.

Use the name of the Simulink.AliasType
object to configure multiple data type
replacements simultaneously. See “Replace
Implementation-Dependent Types with the Same
Type Name” on page 36-6.

Use Simulink Data Type Names Instead of Simulink Coder Data Type Names

For consistency between the data type names that you see in a model and in the generated code, you
can configure data type replacements so the code uses Simulink type names instead of Simulink
Coder names. For each Simulink Coder type that you want to rename, use the Simulink data type
name to specify the replacement name. You do not need to create Simulink.AliasType objects.

To replace boolean_T, int_T, or uint_T, use the information in the table.
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Simulink Coder Type Name Replacement Names to Use
boolean_T One of these names:

• boolean
• uint8
• int8
• intn*

int_T intn*
uint_T uintn*
char_T intn*

* Replace n with the number of bits displayed in Configuration Parameters > Hardware
Implementation for either Number of bits: int or Number of bits: char. Use the appropriate
number of bits for the data type that you want to replace.

You cannot use this technique to replace real_T with double or real32_T with single.

Replace Implementation-Dependent Types with the Same Type Name

Some Simulink Coder type names map to C primitives that are implementation-dependent. For
example, the Simulink Coder type int_T maps to the C type int, whose bit length depends on the
native integer size of your target hardware. Other implementation-dependent types include
boolean_T, char_T, and uint_T.

For more readable, simpler code, you can use the same type name to replace multiple Simulink Coder
types of the same size. For example, if the native integer size of your hardware is 32 bits, you can
replace int_T and int32_T with the same type name, say, myInt.

1 Configure your target hardware settings in Configuration Parameters > Hardware
Implementation.

2 Create a Simulink.AliasType object named myInt. In this case, because int_T and int32_T
represent a 32-bit signed integer, set BaseType to int32.

myInt = Simulink.AliasType('int32')
3 Configure the same data type replacement for int32_T and int_T.
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Note Many-to-one data type replacement does not support the char (char_T) built-in data type. Use
char only in one-to-one data type replacements.

Many-to-one data type replacement is not supported for Simulink Coder data types of different sizes.

Define Abstract Numeric Types and Rename Types

This model shows user-defined types, consisting of numeric and alias types. Numeric types allow you
to define abstract numeric types, which is particularly useful for fixed-point types. Alias types allow
you to rename types, which allows you create a relationship for types.

Explore Example Model

Open the example model and configure it to show the generated names of blocks.

load_system('rtwdemo_udt')
set_param('rtwdemo_udt','HideAutomaticNames','off')
open_system('rtwdemo_udt')
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Key Features of User-Defined Types

• Displayed and propagated on signal lines
• Used to parameterize a model by type (e.g., In1 specifies its Output data type as ENG_SPEED)
• Types with a common ancestor can be mixed, whereby the common ancestor is propagated (e.g.,

output of Sum1)
• Intrinsically supported by the Simulink Model Explorer
• Include an optional header file attribute that is ideal for importing legacy types (ignored for GRT

targets)
• Types used in the generated code (ignored for GRT targets)

Instructions

1 Inspect the user-defined types in the Model Explorer by double-clicking the first yellow button
below.

2 Inspect the replacement data type mapping by double-clicking the second yellow button below.
3 Compile the diagram to display the types in this model (Debug > Update Model > Update Model

or Ctrl+D).
4 Generate code with the blue button below and inspect model files to see how user-defined types

appear in the generated code.
5 Modify the attributes of ENG_SPEED and ENG_SPEED_OFFSET and repeat steps 1-4.

Notes

• User-defined types are a feature of Simulink that facilitate parameterization of the data types in a
model. Embedded Coder preserves alias data type names (e.g., ENG_SPEED) in the generated
code, whereas Simulink Coder implements user-defined types as their base type (e.g., real32_T).
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• Embedded Coder also enables you to replace the built-in data types with user-defined data types
in the generated code.

Control Names of Structure Types
To control the names of the standard structures that Simulink Coder creates by default to store data
(model_P for parameter data, for example), use Configuration Parameters > Code Generation >
Identifiers > Global types to specify a naming rule. For more information, see “Customize
Generated Identifiers” on page 89-18.

When you use nonvirtual buses and parameter structures to aggregate signals and block parameters
into a custom structure in the generated code, control the name of the structure type by creating a
Simulink.Bus object. For more information, see “Organize Data into Structures in Generated Code”
on page 34-145.

Generate Code That Reuses Data Types From External Code
To generate code that reuses a data type definition from your external C code, specify the data scope
of the corresponding data type object or enumeration in Simulink as Imported. With this setting, the
generated code includes (#include) the definition from your code. For more information about
controlling the file placement of a custom data type, see “Control File Placement of Custom Data
Types” on page 36-19.

Instead of creating individual data type objects and enumerated types, and then configuring them,
consider creating the objects and types by using the Simulink.importExternalCTypes function.
By default, the function configures the new objects and types so that the generated code imports
(reuses) the type definitions from your code. You can then use the objects and types to set data types
in a model and to configure data type replacements. For more information, see
Simulink.importExternalCTypes and “Exchange Structured and Enumerated Data Between
Generated and External Code” on page 36-27.

Create Data Type Alias in the Generated Code
This example shows how to configure the generated code to use a data type name (typedef) that you
specify.

Export Type Definition

When you integrate code generated from a model with code from other sources, your model code can
create an exported typedef statement. Therefore, all of the integrated code can use the type. This
example shows how to export the definition of a data type to a generated header file.

Create a Simulink.AliasType object named mySingleAlias that acts as an alias for the built-in
data type single.

mySingleAlias = Simulink.AliasType('single');

Configure the object to export its definition to a header file called myHdrFile.h.

mySingleAlias.DataScope = 'Exported';
mySingleAlias.HeaderFile = 'myHdrFile.h';

Open the model rtwdemo_configinterface.
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open_system('rtwdemo_configinterface')

Configure the model to show the generated names of blocks.

set_param('rtwdemo_configinterface','HideAutomaticNames','off')

On the Modeling tab, click Model Data Editor.

In the model, select the Inport block labeled In1.

Use the Data Type column to set the data type to mySingleAlias.

set_param('rtwdemo_configinterface/In1','OutDataTypeStr','mySingleAlias')

Configure In1 to use default storage.

In the C Code tab, select Code Interface > Default Code Mappings.

In the Code Mappings editor, under Inports and Outports, select category Inports. Set the default
storage class to Default.

On the Inports tab, set Storage Class to Model default.

cm = coder.mapping.api.get('rtwdemo_configinterface');
setDataDefault(cm,'Inports','StorageClass','Default');
setInport(cm,'In1','StorageClass','Model default');
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Generate code from the model.

slbuild('rtwdemo_configinterface')

### Starting build procedure for: rtwdemo_configinterface
### Successful completion of code generation for: rtwdemo_configinterface

Build Summary

Top model targets built:

Model                    Action          Rebuild Reason                                    
===========================================================================================
rtwdemo_configinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.425s

In the code generation report, view the file rtwdemo_configinterface_types.h. The code
creates a #include directive for the generated file myHdrFile.h.

file = fullfile('rtwdemo_configinterface_ert_rtw','rtwdemo_configinterface_types.h');
rtwdemodbtype(file,'#include "myHdrFile.h"',...
    '#include "myHdrFile.h"',1,1)

#include "myHdrFile.h"

View the file myHdrFile.h. The code uses the identifier mySingleAlias as an alias for the data
type real32_T. By default, generated code represents the Simulink data type single by using the
identifier real32_T.

The code also provides a macro guard of the form RTW_HEADER_filename_h_. When you export a
data type definition to integrate generated code with code from other sources, you can use macro
guards of this form to prevent unintentional identifier clashes.

file = fullfile('slprj','ert','_sharedutils','myHdrFile.h');
rtwdemodbtype(file,'#ifndef RTW_HEADER_myHdrFile_h_',...
    ' * File trailer for generated code.',1,0)

#ifndef RTW_HEADER_myHdrFile_h_
#define RTW_HEADER_myHdrFile_h_
#include "rtwtypes.h"

typedef real32_T mySingleAlias;
typedef creal32_T cmySingleAlias;

#endif                                 /* RTW_HEADER_myHdrFile_h_ */

/*

View the file rtwdemo_configinterface.h. The code uses the data type alias mySingleAlias to
define the structure field input1, which corresponds to the Inport block labeled In1.

file = fullfile('rtwdemo_configinterface_ert_rtw','rtwdemo_configinterface.h');
rtwdemodbtype(file,...
    '/* External inputs (root inport signals with default storage) */',...
    '} ExtU_rtwdemo_configinterface_T;',1,1)
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/* External inputs (root inport signals with default storage) */
typedef struct {
  mySingleAlias input1;                /* '<Root>/In1' */
  MYTYPE input2;                       /* '<Root>/In2' */
  MYTYPE input3;                       /* '<Root>/In3' */
  MYTYPE input4;                       /* '<Root>/In4' */
} ExtU_rtwdemo_configinterface_T;

Import Type Definition

When you integrate code generated from a model with code from other sources, to avoid redundant
typedef statements, you can import a data type definition from the external code. This example
shows how to import your own definition of a data type from a header file that you create.

Use a text editor to create a header file to import. Name the file ex_myImportedHdrFile.h. Place it
in your working folder. Copy the following code into the file.

#ifndef HEADER_myImportedHdrFile_h_
#define HEADER_myImportedHdrFile_h_

typedef float myTypeAlias;

#endif 

The code uses the identifier myTypeAlias to create an alias for the data type float. The code also
uses a macro guard of the form HEADER_filename_h. When you import a data type definition to
integrate generated code with code from other sources, you can use macro guards of this form to
prevent unintentional identifier clashes.

At the command prompt, create a Simulink.AliasType object named myTypeAlias that creates
an alias for the built-in type single. The Simulink data type single corresponds to the C data type
float.

myTypeAlias = Simulink.AliasType('single')

myTypeAlias = 

  AliasType with properties:

    Description: ''
      DataScope: 'Auto'
     HeaderFile: ''
       BaseType: 'single'

Configure the object so that generated code imports the type definition from the header file
ex_myImportedHdrFile.h.

myTypeAlias.DataScope = 'Imported';
myTypeAlias.HeaderFile = 'ex_myImportedHdrFile.h';

Open the model rtwdemo_configinterface.

open_system('rtwdemo_configinterface')

36 Data Types in Embedded Coder

36-12



On the Modeling tab, click Model Data Editor.

In the model, select the Inport block labeled In1.

Use the Data Type column to set the data type to myTypeAlias.

set_param('rtwdemo_configinterface/In1','OutDataTypeStr','myTypeAlias')

Generate code from the model.

slbuild('rtwdemo_configinterface')

### Starting build procedure for: rtwdemo_configinterface
### Successful completion of code generation for: rtwdemo_configinterface

Build Summary

Top model targets built:

Model                    Action          Rebuild Reason                   
==========================================================================
rtwdemo_configinterface  Code generated  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.634s

In the code generation report, view the file rtwdemo_configinterface_types.h. The code
creates a #include directive for your header file ex_myImportedHdrFile.h.

file = fullfile('rtwdemo_configinterface_ert_rtw','rtwdemo_configinterface_types.h');
rtwdemodbtype(file,'#include "ex_myImportedHdrFile.h',...
    '/* Forward declaration for rtModel */',1,0)

#include "ex_myImportedHdrFile.h"
#include "MYTYPE.h"

/* Model Code Variants */
#ifndef DEFINED_TYPEDEF_FOR_Table1_Type_
#define DEFINED_TYPEDEF_FOR_Table1_Type_

typedef struct {
  MYTYPE BP[11];
  MYTYPE Table[11];
} Table1_Type;

#endif

#ifndef DEFINED_TYPEDEF_FOR_Table2_Type_
#define DEFINED_TYPEDEF_FOR_Table2_Type_

typedef struct {
  MYTYPE BP1[3];
  MYTYPE BP2[3];
  MYTYPE Table[9];
} Table2_Type;

#endif
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#endif                         /* RTW_HEADER_rtwdemo_configinterface_types_h_ */

/*
 * File trailer for generated code.
 *
 * [EOF]
 */

View the file rtwdemo_configinterface.h. The code uses the data type alias myTypeAlias to
define the structure field input1, which corresponds to the Inport block labeled In1.

file = fullfile('rtwdemo_configinterface_ert_rtw','rtwdemo_configinterface.h');
rtwdemodbtype(file,...
    '/* External inputs (root inport signals with default storage) */',...
    '} ExtU_rtwdemo_configinterface_T;',1,1)

/* External inputs (root inport signals with default storage) */
typedef struct {
  myTypeAlias input1;                  /* '<Root>/In1' */
  MYTYPE input2;                       /* '<Root>/In2' */
  MYTYPE input3;                       /* '<Root>/In3' */
  MYTYPE input4;                       /* '<Root>/In4' */
} ExtU_rtwdemo_configinterface_T;

Display Base Data Types and Aliases on Model Diagram

When you display signal data types on the model diagram, you can choose to display aliases (such as
myTypeAlias) and base data types (such as int16). To display aliases, on the Debug tab, select
Information Overlays > Alias Data Types. To display the base types, select Information Overlays
> Base Data Types. For more information, see “Port Data Types”.

Create a Named Fixed-Point Data Type in the Generated Code
This example shows how to create and name a fixed-point data type in generated code. You can use
the name of the type to specify parameter and signal data types throughout a model and in generated
code.

The example model rtwdemo_fixpt1 uses fixed-point data types. So that you can more easily see
the fixed-point data type in the generated code, in this example, you create a Simulink.Parameter
object that appears in the code as a global variable.

Create a Simulink.AliasType object that defines a fixed-point data type. Name the object
myFixType. The generated code uses the name of the object as a data type.

myFixType = Simulink.AliasType('fixdt(1,16,4)');

Open the model rtwdemo_fixpt1.

open_system('rtwdemo_fixpt1')
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Configure the model to show the generated names of the blocks.

set_param('rtwdemo_fixpt1','HideAutomaticNames','off')

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, select the Parameters tab.

In the model, select the Gain block.

In the Model Data Editor, for the row that represents the Gain parameter of the Gain block, in the
Value column, specify myParam.

Click the action button (with three vertical dots) next to the parameter value. Select Create.

In the Create New Data dialog box, set Value to Simulink.Parameter(8). In this example, for
more easily readable code, you set the parameter value to 8 instead of -3.2. Click Create. A
Simulink.Parameter object named myParam appears in the base workspace. The object stores the
real-world value 8, which the Gain block uses for the value of the Gain parameter.

In the Simulink.Parameter property dialog box, set Storage class to ExportedGlobal. Click OK.
With this setting, myParam appears in the generated code as a separate global variable.

In the Model Data Editor, use the Data Type column to set the data type of the Gain parameter of the
Gain block to myFixType.

On the Signals tab, use the Data Type column to set the data type of the Gain block output to
myFixType.

Use the Data Type column to set the data type of the Conversion block output to myFixType.
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Alternatively, you can use these commands at the command prompt to configure the blocks and
create the object:

set_param('rtwdemo_fixpt1/Gain','Gain','myParam','OutDataTypeStr','myFixType',...
    'ParamDataTypeStr','myFixType')
myParam = Simulink.Parameter(8);
myParam.StorageClass = 'ExportedGlobal';
set_param('rtwdemo_fixpt1/Conversion','OutDataTypeStr','myFixType')

In the model, set Configuration Parameters > Code Generation > System target file to
ert.tlc. With this setting, the code generator honors data type aliases such as myFixType.

set_param('rtwdemo_fixpt1','SystemTargetFile','ert.tlc')

Select the configuration parameter Generate code only.

set_param('rtwdemo_fixpt1','GenCodeOnly','on')

Generate code from the model.

slbuild('rtwdemo_fixpt1')

### Starting build procedure for: rtwdemo_fixpt1
### Successful completion of code generation for: rtwdemo_fixpt1

Build Summary

Top model targets built:

Model           Action          Rebuild Reason                                    
==================================================================================
rtwdemo_fixpt1  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.602s

In the code generation report, view the file rtwdemo_fixpt1_types.h. The code defines the type
myFixType based on an integer type of the specified word length (16).

file = fullfile('rtwdemo_fixpt1_ert_rtw','rtwdemo_fixpt1_types.h');
rtwdemodbtype(file,'#ifndef DEFINED_TYPEDEF_FOR_myFixType_',...
    '/* Forward declaration for rtModel */',1,0)

#ifndef DEFINED_TYPEDEF_FOR_myFixType_
#define DEFINED_TYPEDEF_FOR_myFixType_

typedef int16_T myFixType;
typedef cint16_T cmyFixType;

#endif

View the file rtwdemo_fixpt1.c. The code uses the type myFixType, which is an alias of the
integer type int16, to define the variable myParam.

file = fullfile('rtwdemo_fixpt1_ert_rtw','rtwdemo_fixpt1.c');
rtwdemodbtype(file,'myFixType myParam = 128;','myFixType myParam = 128;',1,1)
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myFixType myParam = 128;               /* Variable: myParam

The stored integer value 128 of myParam is not the same as the real-world value 8 because of the
scaling that the fixed-point data type myFixType specifies. For more information, see “Scaling”
(Fixed-Point Designer) in the Fixed-Point Designer documentation.

The line of code that represents the Gain block applies a right bit shift corresponding to the fraction
length specified by myFixType.

rtwdemodbtype(file,...
    'rtwdemo_fixpt1_Y.Out1 = (myFixType)((myParam * rtb_Conversion) >> 4);',...
    'rtwdemo_fixpt1_Y.Out1 = (myFixType)((myParam * rtb_Conversion) >> 4);',1,1)

  rtwdemo_fixpt1_Y.Out1 = (myFixType)((myParam * rtb_Conversion) >> 4);

Rename Data Type Object
To rename a data type object such as Simulink.AliasType or Simulink.Bus after you create it
(for example, to rename an alias when coding standards change or when you encounter a naming
conflict), you can allow Simulink to rename the object and correct all of the references to the object
that appear in a model or models. In the Model Explorer, right-click the variable and select Rename
All. For more information, see “Rename Variables”.

Display Signal Data Types on Block Diagram
For readability, you can display signal data types directly on a block diagram. When you use custom
names for primitive data types, you can choose to display the custom name (the alias), the underlying
primitive, or both. See “Port Data Types”.

Limitations
• You cannot configure the generated code to use these custom C data types:

• Array types
• Pointer types
• const or volatile types

• You cannot configure the generated code to use generic C primitive types such as int and short.

Data Type Replacement Limitations

When you select the model configuration parameter Replace data type names in the generated
code on the Code Generation > Data Type Replacement pane of the Configuration Parameters
dialog box, these limitations apply:

• Data type replacement does not support multiple levels of mapping. Each replacement data type
name maps directly to one or more built-in data types.

• Data type replacement is not supported for simulation target code generation for referenced
models.

• If you select the Classic call interface configuration parameter for your model, data type
replacement is not supported.
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• Code generation performs data type replacements while generating .c, .cpp, and .h files. Code
generation places these files in build folders (including top and referenced model build folders)
and in the _sharedutils folder. Exceptions are as follows:

rtwtypes.h
multiword_types.h
model_reference_types.h
builtin_typeid_types.h
model_sf.c or .cpp (ERT S-function wrapper)
model_dt.h (C header file supporting external mode)
model_capi.c or .cpp
model_capi.h

• Data type replacement is not supported for complex data types.
• Many-to-one data type replacement is not supported for the char data type. Attempting to use

char as part of a many-to-one mapping to a custom data type represents a violation of the MISRA
C specification. For example, if you map char (char_T) and either int8 (int8_T) or uint8
(uint8_T) to the same replacement type, the result is a MISRA C violation. If you try to generate
C++ code, the code generator makes invalid implicit type casts, resulting in compile-time errors.
Use char only in one-to-one data type replacements.

Many-to-one data type replacement is not supported for Simulink Coder data types of different
sizes. For more information, see “Replace Implementation-Dependent Types with the Same Type
Name” on page 36-6.

• For ERT S-functions, replace the boolean data type with only an 8-bit integer, int8, or uint8.
• Set the DataScope property of a Simulink.AliasType object to Auto (default) or Imported.

See Also

Related Examples
• “Exchange Structured and Enumerated Data Between Generated and External Code” on page

36-27
• “Replace and Rename Data Types to Conform to Coding Standards” on page 36-22
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Control File Placement of Custom Data Types
By default, when you use data type objects, such as Simulink.AliasType and Simulink.Bus, and
custom enumerations to specify data types for signals and block parameters, the code generated from
the model defines the types (for example, with typedef statements). To ease integration of the
generated code with other existing code and to modularize the generated code, you can control the
file placement of the type definitions by adjusting the properties of the objects and the enumerations.

Data Scope and Header File
To control the file placement of a custom type definition in generated code, set the DataScope and
HeaderFile properties of the data type object according to the table. Similarly, for an enumeration
that you define in a MATLAB file, set the return arguments of the getDataScope and
getHeaderFile methods.

• typename is the name of the custom data type.
• filename is the name of a header file.
• model is the name of the model.

Goal Specify DataScope as Specify HeaderFile as
Export type definition to
model_types.h

Auto Empty

Import type definition from a
header file that you create,
filename

Auto or Imported filename (if necessary, include
a .h extension)

Export type definition to a
generated header file,
filename.h

Exported filename or filename.h

Export type definition to a
generated header file,
typename.h

Exported Empty

When you import a data type definition (for example, by setting DataScope to Imported), the
generated model code creates an #include directive for your header file in place of a type definition.
You supply the header file that contains the definition.

Considerations for Data Type Replacement

• If you use data type replacement to replace a built-in Simulink data type with your own data type
in generated code (see “Model Configuration Parameters: Code Generation Data Type
Replacement”), typedef statements and #include directives appear in rtwtypes.h instead of
model_types.h.

• When a Simulink.AliasType or Simulink.NumericType object participates in data type
replacements, you cannot set the DataScope property of the object to Exported. Therefore, if
you want the code generator to generate the corresponding typedef statement, you cannot
control the file placement of the statement. However, you can set DataScope to Imported, which
means that you can configure the code to reuse the typedef statement that your external code
provides.

As a workaround, instead of using the data type object as a data type replacement, use the object
to set the data types of individual data items in a model. To configure many data items, you can
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use the Model Data Editor and take advantage of data type propagation and inheritance. For more
information, see “Control Names of Primitive Data Types” on page 36-2.

Import Definition of Numerically Complex Data Type

You can use a Simulink.AliasType object with numerically complex data (i). In this case, if you
configure the generated code to import the type definition from your external code (for example, by
setting the DataScope property to Imported), your code must provide two complementary typedef
statements.

Suppose your external header file myAliasTypes.h defines the data type IAT_int32 as an alias of
a 32-bit integer. The file must define two types: IAT_int32 and cIAT_int32:

#ifndef myAliasTypes_H_
#define myAliasTypes_H_

#include "rtwtypes.h"

typedef int32_T IAT_int32;
typedef cint32_T cIAT_int32;

#endif 

You do not need to create two Simulink.AliasType objects. In this example, you create one object,
IAT_int32. The generated code then creates complex data (variables) by using both IAT_int32 and
cIAT_int32.

Macro Guards
When you export one or more data type definitions to a generated header file, the file contains a file-
level macro guard of the form RTW_HEADER_filename_h.

Suppose that you use several Simulink.AliasType objects: mySingleAlias, myDoubleAlias,
and myIntAlias with these properties:

• DataScope set to Exported
• HeaderFile set to myTypes.h

When you generate code, the guarded file myTypes.h contains the typedef statements:

#ifndef RTW_HEADER_myTypes_h_
#define RTW_HEADER_myTypes_h_
#include "rtwtypes.h"

typedef real_T myDoubleAlias;
typedef real32_T mySingleAlias;
typedef int16_T myIntAlias;

#endif        

When you export data type definitions to model_types.h, the file contains a macro guard of the
form _DEFINED_TYPEDEF_FOR_typename_ for each typedef statement. Suppose that you use a
Simulink.AliasType object mySingleAlias with these properties:

• DataScope set to Auto
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• HeaderFile not specified

When you generate code, the file model_types.h contains the guarded typedef statement:

#ifndef _DEFINED_TYPEDEF_FOR_mySingleAlias_
#define _DEFINED_TYPEDEF_FOR_mySingleAlias_

typedef real32_T mySingleAlias;

#endif

See Also
Simulink.AliasType | Simulink.Bus | Simulink.NumericType

Related Examples
• “Control Data Type Names in Generated Code” on page 36-2
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Replace and Rename Data Types to Conform to Coding
Standards

By default, the generated code uses data type aliases such as real_T and int32_T. The code uses
these aliases to define global and local variables. If your coding standards require that you use other
data type aliases, including aliases that your existing code defines, you can:

• Configure data type replacement for the entire model.
• Configure individual data items (such as signals, parameters, and states) to use specific data type

aliases.

For information about controlling data types in a model, see “Control Signal Data Types”.

Inspect External C Code
Save this C code into a file named my_types.h in your current folder. This file represents a header
file in your existing code that defines custom data type aliases by using typedef statements.

#include <stdbool.h>

typedef double my_dblPrecision;
typedef short my_int16;
typedef bool my_bool;

Explore Example Model and Default Generated Code
1 Open the example model ex_data_type_replacement.

open_system(fullfile(docroot,'toolbox','ecoder','examples',...
'ex_data_type_replacement'))

2 On the Modeling tab, click Model Data Editor.
3 In the Model Data Editor, inspect the Signals tab.
4 Set the Change view drop-down list to Code. In the data table, the Storage Class column shows

that named signal lines such as temp use the storage class ExportedGlobal. With this setting,
the signal lines appear in the generated code as separate global variables.

5 Set the Change view drop-down list to Design.
6 Update the block diagram.

Simulink assigns a specific data type to each signal that uses an inherited data type setting such
as Inherit: Inherit via internal rule.

7 In the data table, expand the width of the Data Type column. The column shows that the signals
in the model use a mix of the data types int16, double, and boolean. You can also see these
data types in the model.

8 Generate code from the model.
9 In the code generation report, inspect the shared utility file rtwtypes.h. The code uses

typedef statements to rename the primitive C data types by using standard Simulink Coder
aliases. For example, the code renames the primitive type double by using the alias real_T.

typedef double real_T;
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10 Inspect the file ex_data_type_replacement.c. The code uses the default data type aliases to
declare and define variables. For example, the code uses the data types real_T, int16_T, and
boolean_T to define the global variables flowIn, temp, and intlk.

real_T flowIn;                         /* '<Root>/In3' */
int16_T temp;                          /* '<Root>/Add2' */
boolean_T intlk;                       /* '<S1>/Compare' */

The model step function defines local variables by using the same data type aliases.

real_T rtb_Add;
real_T rtb_FilterCoefficient;

Reuse External Data Type Definitions
Configure the generated code to define variables by using the custom data types defined in
my_types.h instead of the default type names.

1 At the command prompt, create a Simulink.AliasType object for each data type alias that
your external code defines.

Simulink.importExternalCTypes('my_types.h');

In the base workspace, the Simulink.importExternalCTypes function creates the objects
my_dblPrecision, my_int16, and my_bool.

For each object, the function sets the DataScope property to 'Imported' and the HeaderFile
property to 'my_types.h'. With these settings, the code generator does not create a typedef
statement for each object, but instead the generated code reuses the statements from
my_types.h by including (#include) the file.

2 In the model, in the Configuration Parameters dialog box, on the Code Generation > Data Type
Replacement pane, select Replace data type names in the generated code.

3 Specify the options in the Replacement Name column according to the table.

Simulink Name Replacement Name
double my_dblPrecision
int16 my_int16
boolean my_bool

4 Generate code from the model.
5 In the code generation report, inspect the file rtwtypes.h. Now, the code uses an #include

directive to import the contents of the external header file my_types.h, which contains the
custom data type aliases.

#include "my_types.h"     /* User defined replacement datatype for int16_T real_T boolean_T  */

6 Inspect the file ex_data_type_replacement.c. The code uses the custom data type aliases
my_dblPrecision, my_int16, and my_bool to define the global variables such as flowIn,
temp, and intlk.

my_dblPrecision flowIn;                /* '<Root>/In3' */
my_int16 temp;                         /* '<Root>/Add2' */
my_bool intlk;                         /* '<S1>/Compare' */
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The model step function defines local variables by using the custom data type aliases.

my_dblPrecision rtb_Add;
my_dblPrecision rtb_FilterCoefficient;

Create Meaningful Data Type Aliases for Individual Data Items
Suppose that your coding standards require that important data items use a data type whose name
indicates the real-world significance. You can create more Simulink.AliasType objects to
represent these custom data type aliases. Use the objects to set the data types of data items in the
model.

1 In the Model Data Editor Data Type column, use the Simulink.AliasType objects to set the
data types of these block outputs. You can select a signal line in the model, which highlights the
corresponding row in the Model Data Editor, or search for the signals in the Model Data Editor
by using the Filter contents box.

Block Output Data Type
Flow Setpoint flow_T
Add2 (which feeds the Compare block) diffTemp_T

2 Use the Model Data Editor Inports/Outports tab to set the data type of the third Inport block to
flow_T.

3 On the Modeling tab, under Design, click Property Inspector.
4 Select the block labeled Flow Controller. In the Property Inspector, click Open to open the block

dialog box.
5 On the Data Types tab, set Sum output to ctrl_T. Click OK.

With these data type settings, some of the named signals, such as temp and flowIn, use data
types that evoke real-world quantities, such as liquid flow rate and temperature.

6 At the command prompt, create Simulink.AliasType objects to represent these new custom
data type aliases.

flow_T = Simulink.AliasType('double');
diffTemp_T = Simulink.AliasType('int16');
ctrl_T = Simulink.AliasType('double');

In the model, the signals flowIn and flowSetPt use the primitive data type double, so the
data type alias flow_T maps to double.

7 Update the block diagram.

Due to data type inheritance, other signals also use the custom data type aliases. For example,
the output data type of the Add block fed by the third Inport block is set to Inherit: Inherit
via internal rule. The internal rule chooses the same data type that the block inputs use,
flow_T.

8 Generate code from the model.
9 The file ex_data_type_replacement_types.h defines the new data types flow_T,

diffTemp_T, and ctrl_T as aliases of my_dblPrecision and my_int16.

typedef my_dblPrecision flow_T;
typedef my_int16 diffTemp_T;
typedef my_dblPrecision ctrl_T;
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10 In the file ex_data_type_replacement.c, the code defines global variables by using the new
type names.

flow_T flowIn;                         /* '<Root>/In3' */
flow_T flowSetPt;                      /* '<Root>/Flow Setpoint' */
ctrl_T flowCtrl;                       /* '<Root>/Interlock' */
diffTemp_T temp;                           /* '<Root>/Add2' */

11 For blocks that do not use the new data types, the corresponding generated code continues to
use the replacement types that you specified earlier. For example, in the file
ex_data_type_replacement.h, the outputs of the blocks In1 and In2 appear as structure
fields that use the replacement type my_int16.

/* External inputs (root inport signals with auto storage) */
typedef struct {
  my_int16 In1;                        /* '<Root>/In1' */
  my_int16 In2;                        /* '<Root>/In2' */
} ExtU_ex_data_type_replacement_T;

Create Single Point of Definition for Primitive Types
The custom data type aliases flow_T and ctrl_T map to the primitive data type double. If you want
to change this underlying data type from double to single (float), you must remember to modify
the BaseType property of both Simulink.AliasType objects.

To more easily make this change, you can create a Simulink.NumericType object and configure
both Simulink.AliasType objects to refer to it. Then, you need to modify only the
Simulink.NumericType object. A Simulink.NumericType object enables you to share a data
type without creating a data type alias.

1 At the command prompt, create a Simulink.NumericType object to represent the primitive
data type single.

sharedType = Simulink.NumericType;
sharedType.DataTypeMode = 'Single';

2 Configure the Simulink.AliasType objects flow_T and ctrl_T to acquire an underlying data
type from this new object.

flow_T.BaseType = 'sharedType';
ctrl_T.BaseType = 'sharedType';

3 On the Debug tab, select Information Overlays > Base Data Types Information Overlays >
Alias Data Typesand (see “Port Data Types”). Update the block diagram.

The data type indicators in the model show that the aliases flow_T and ctrl_T map to the
primitive type single. To change this underlying primitive type, you can modify the
DataTypeMode property of the Simulink.NumericType object, sharedType.

By default, the Simulink.NumericType object does not cause another typedef statement to
appear in the generated code.

If you generate code from the model while the Simulink.NumericType object represents the data
type single, the generated code maps flow_T and ctrl_T to the default Simulink Coder data type
alias real32_T, which maps to the C data type float. You can replace real32_T in the same way
that you replaced real_T, int16_T, and boolean_T (Configuration Parameters > Code
Generation > Data Type Replacement).
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Permanently Store Data Type Objects
The Simulink.NumericType and Simulink.AliasType objects in the base workspace do not
persist if you end your current MATLAB session. To permanently store these objects, consider
migrating your model to a data dictionary. See “Migrate Models to Use Simulink Data Dictionary”.

Create and Maintain Objects Corresponding to Multiple C typedef
Statements
To create Simulink.AliasType objects for a large number of typedef statements in your external
C code, consider using the Simulink.importExternalCTypes function.

See Also

Related Examples
• “Model Configuration Parameters: Code Style”
• “Unit Specification in Simulink Models”
• “Design Data Interface by Configuring Inport and Outport Blocks” on page 34-167
• “Choose an External Code Integration Workflow” on page 56-3
• “Control File Placement of Custom Data Types” on page 36-19
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Exchange Structured and Enumerated Data Between
Generated and External Code

This example shows how to generate code that exchanges data with external, existing code.
Construct and configure a model to match data types with the external code and to avoid duplicating
type definitions and memory allocation (definition of global variables). Then, compile the generated
code together with the external code into a single application.

Inspect External Code
Create the file ex_cc_algorithm.c in your current folder.

#include "ex_cc_algorithm.h"

inSigs_T inSigs;

float_32 my_alg(void)
{
    if (inSigs.err == TMP_HI) {
        return 27.5;
    }
    else if (inSigs.err == TMP_LO) {
        return inSigs.sig1 * calPrms.cal3;
    }
    else {
        return inSigs.sig2 * calPrms.cal3;
    }
}
        

The C code defines a global structure variable named inSigs. The code also defines a function,
my_alg, that uses inSigs and another structure variable named calPrms.

Create the file ex_cc_algorithm.h in your current folder.

#ifndef ex_cc_algorithm_h
#define ex_cc_algorithm_h

typedef float float_32;

typedef enum {
    TMP_HI = 0,
    TMP_LO,
    NORM,
} err_T;

typedef struct inSigs_tag {
    err_T err;
    float_32 sig1;
    float_32 sig2;
} inSigs_T;

typedef struct calPrms_tag {
    float_32 cal1;
    float_32 cal2;
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    float_32 cal3;
} calPrms_T;

extern calPrms_T calPrms;
extern inSigs_T inSigs;

float_32 my_alg(void);

#endif

The file defines float_32 as an alias of the C data type float. The file also defines an enumerated
data type, err_T, and two structure types, inSigs_T and calPrms_T.

The function my_alg is designed to calculate a return value by using the fields of inSigs and
calPrms, which are global structure variables of the types inSigs_T and calPrms_T. The function
requires another algorithm to supply the signal data that inSigs stores.

This code allocates memory for inSigs, but not for calPrms. Create a model whose generated code:

• Defines and initializes calPrms.
• Calculates values for the fields of inSigs.
• Reuses the type definitions (such as err_T and float_32) that the external code defines.

Create Simulink Model
1 So that you can create enumerated and structured data in the Simulink model, first create

Simulink representations of the data types that the external code defines. Store the Simulink
types in a new data dictionary named ex_cc_integ.sldd.

Simulink.importExternalCTypes('ex_cc_algorithm.h',...
    'DataDictionary','ex_cc_integ.sldd');

The data dictionary appears in your current folder.
2 To inspect the dictionary contents in the Model Explorer, in your current folder, double-click the

file, ex_cc_integ.sldd.

The Simulink.importExternalCTypes function creates Simulink.Bus,
Simulink.AliasType, and Simulink.data.dictionary.EnumTypeDefinition objects
that correspond to the custom C data types from ex_cc_algorithm.h.

3 Create a new model and save it in your current folder as ex_struct_enum_integ.
4 Link the model to the data dictionary. On the Modeling tab, under Design, click Data

Dictionary.
5 Add algorithmic blocks that calculate the fields of inSigs.
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Now that you have the algorithm model, you must:

• Organize the output signals into a structure variable named inSigs.
• Create the structure variable calPrms.
• Include ex_cc_algorithm.c in the build process that compiles the code after code generation.

Configure Generated Code to Write Output Data to Existing Structure
Variable
1 Add a Bus Creator block near the existing Outport blocks. The output of a Bus Creator block is a

bus signal, which you can configure to appear in the generated code as a structure.
2 In the Bus Creator block, set these parameters:
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• Number of inputs to 3
• Output data type to Bus: inSigs_T
• Output as nonvirtual bus to selected

3 Delete the three existing Outport blocks (but not the signals that enter the blocks).
4 Connect the three remaining signal lines to the inputs of the Bus Creator block.
5 Add an Outport block after the Bus Creator block. Connect the output of the Bus Creator to the

Outport.
6 In the Outport block, set the Data type parameter to Bus: inSigs_T.
7 On the Modeling tab, click Model Data Editor.
8 On the Inports/Outports tab, for the Inport blocks labeled In2 and In3, change Data Type

from Inherit: auto to float_32.
9 Change the Change View drop-down list from Design to Code.
10 For the Outport block, set Signal Name to inSigs.
11 Set Storage Class to ImportFromFile.
12 Set Header File to ex_cc_algorithm.h.
13 Inspect the Signals tab.
14 In the model, select the output signal of the Multiport Switch block.
15 In the Model Data Editor, for the selected signal, set Name to err.
16 Set the name of the output signal of the Gain block to sig1.
17 Set the name of the output signal of the Gain1 block to sig2.

When you finish, the model stores output signal data (such as the signals err and sig1) in the fields
of a structure variable named inSigs.
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Because you set Storage Class to ImportFromFile, the generated code does not allocate memory
for inSigs.

Configure Generated Code to Define Parameter Data
Configure the generated code to define the global structure variable, calPrms, that the external code
needs.

1 In the Model Explorer Model Hierarchy pane, under the dictionary node ex_cc_integ, select
the Design Data node.

2 In the Contents pane, select the Simulink.Bus object calPrms_T.
3 In the Dialog pane (the right pane), click Launch Bus Editor.
4 In the Bus Editor, in the left pane, select calPrms_T.
5 On the Bus Editor toolbar, click the Create/Edit a Simulink.Parameter Object from a Bus

Object button.
6 In the MATLAB Editor, copy the generated MATLAB code and run the code at the command

prompt. The code creates a Simulink.Parameter object in the base workspace.
7 In the Model Explorer Model Hierarchy pane, select Base Workspace.
8 Use the Model Explorer to move the parameter object, calPrms_T_Param, from the base

workspace to the Design Data section of the data dictionary.
9 With the data dictionary selected, in the Contents pane, rename the parameter object as

calPrms.
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10 In the Model Data Editor, select the Parameters tab.
11 Set the Change view drop-down list to Design.
12 For the Gain block, replace the value 13.8900013 with calPrms.cal1.
13 In the other Gain block, use calPrms.cal2.
14 While editing the value of the other Gain block, next to calPrms.cal2, click the action button 

and select calPrms > Open.
15 In the calPrms property dialog box, next to the Value box, click the action button  and select

Open Variable Editor.
16 Use the Variable Editor to set the field values in the parameter object.

• For the fields cal1 and cal2, use the numeric values that the Gain blocks in the model
previously used.

• For cal3, use a nonzero number such as 15.2299995.

When you finish, close the Variable Editor.
17 In the property dialog box, set Storage class to ExportedGlobal. Click OK.
18 Use the Model Explorer to save the changes that you made to the dictionary.

Generate, Compile, and Inspect Code
1 Configure the model to include ex_cc_algorithm.c in the build process. Set Configuration

Parameters > Code Generation > Custom Code > Additional build information > Source
files to ex_cc_algorithm.c.

2 Generate code from the model.
3 Inspect the generated file ex_struct_enum_integ.c. The file defines and initializes calPrms.

/* Exported block parameters */
calPrms_T calPrms = {
  13.8900013F,
  0.998300076F,
  15.23F
} ;                                    /* Variable: calPrms

The generated algorithm in the model step function defines a local variable for buffering the
value of the signal err.

err_T rtb_err;

The algorithm then calculates and stores data in the fields of inSig.

inSigs.err = rtb_err;
inSigs.sig1 = (rtU.In2 + rtDW.DiscreteTimeIntegrator_DSTATE) * calPrms.cal1;
inSigs.sig2 = (real32_T)(calPrms.cal2 * rtDW.DiscreteTimeIntegrator_DSTATE);

Replace Data Type Names Throughout Model
To generate code that uses float_32 instead of the default, real32_T, instead of manually
specifying the data types of block output signals and bus elements, you can use data type
replacement (Configuration Parameters > Code Generation > Data Type Replacement). For
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more information, see “Replace and Rename Data Types to Conform to Coding Standards” on page
36-22.

See Also
Simulink.importExternalCTypes

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code”
• “Control Data Type Names in Generated Code” on page 36-2
• “Use Enumerated Data in Generated Code” on page 34-84
• “Organize Data into Structures in Generated Code” on page 34-145
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Specify Boolean and Data Type Limit Identifiers
You can use command-line parameters to replace the default Boolean and data type limit identifiers.
If you want to associate the data type limit identifiers with the data type names, consider replacing
the default identifiers. You can also use command-line parameters to import a header file with the
Boolean and data type limit identifier definitions.

Data Type Limit Identifiers
You can control the data type limit identifiers in the generated code by using the command-line
parameters in this table.

Data Type Limit Default Identifier Command-Line Parameter
64-bit integer maximum MAX_int64_T MaxIdInt64
16-bit integer maximum MAX_int16_T MaxIdInt16
32-bit integer maximum MAX_int32_T MaxIdInt32
8-bit integer maximum MAX_int8_T MaxIdInt8
64-bit unsigned integer maximum MAX_uint64_T MaxIdUint64
16-bit unsigned integer maximum MAX_uint16_T MaxIdUint16
32-bit unsigned integer maximum MAX_uint32_T MaxIdUint32
8-bit unsigned integer maximum MAX_uint8_T MaxIdUint8
64-bit integer minimum identifier MIN_int64_T MinIdInt64
16-bit integer minimum MIN_int16_T MinIdInt16
32-bit integer minimum MIN_int32_T MinIdInt32
8-bit integer minimum MIN_int8_T MinIdInt8

For example, to change the default identifiers for the 8-bit integer data limit minimum and maximum
to s4g_S4MIN and s4g_S4MAX, respectively:

set_param(gcs,'MinIdInt8','s4g_S4MIN');
set_param(gcs,'MaxIdInt8','s4g_S4MAX')

If you do not import a header file, the generated file rtwtypes.h defines the 8-bit integer data
minimum and maximum identifiers:

#define s4g_S4MAX                      ((int8_T)(127))
#define s4g_S4MIN                      ((int8_T)(-128))

If you do import a header file defining the data type limit identifiers, the header file is included in
rtwtypes.h.

Boolean Identifiers
You can control the Boolean identifiers in the generated code by using the command-line parameters
in this table. When changing boolean identifiers, you must define false to be numerically equivalent
to 0, and true to be numerically equivalent to 1.
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Boolean Default Identifier Command-Line Parameter
True true BooleanTrueId
False false BooleanFalseId

For example, to change the default Boolean true and false identifiers:

set_param(gcs,'BooleanTrueId','bTrue');
set_param(gcs,'BooleanFalseId','bFalse')

If you do not import a header file, the generated file rtwtypes.h defines the Boolean identifiers:

#define bFalse                         (0U)
#define bTrue                          (1U)

If you do import a header file defining the Boolean identifiers, the header file is included in
rtwtypes.h.

Note When changing boolean identifiers, you must define false to be numerically equivalent to 0,
and true to be numerically equivalent to 1.

Boolean and Data Type Limit Identifier Header Files
You can import a header file that defines Boolean and data type limit identifiers by using the
configuration parameter Type limit identifier replacement header file or command-line parameter
TypeLimitIdReplacementHeaderFile. The header file is included in rtwtypes.h. You must use
the command-line parameters to specify the Boolean and data type limit identifiers that are included
in the imported header file.

For example, if you have a header file myfile.h with data type limit definitions, use
TypeLimitIdReplacementHeaderFile to include the definitions in the generated code:

set_param(gcs,'TypeLimitIdReplacementHeaderFile','myfile.h');

The generated file rtwtypes.h includes myfile.h.

/* Import type limit identifier replacement definitions. */
#include "myfile.h"

See Also

Related Examples
• “Replace and Rename Data Types to Conform to Coding Standards” on page 36-22
• “Model Configuration Parameters: Code Generation Data Type Replacement”
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MPT Data Object Properties
The following table describes the properties and property values for mpt.Parameter and
mpt.Signal data objects that appear in the Model Explorer.

Note You can create mpt.Signal and mpt.Parameter objects in the base MATLAB or model
workspace. However, if you create a signal object in a model workspace, the object's storage class
must be set to Auto.

The figure below shows an example of the Model Explorer. When you select an mpt.Parameter or
mpt.Signal data object in the middle pane, its properties and property values display in the
rightmost pane.

In the Properties column, the table lists the properties in the order in which they appear on the
Model Explorer.
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Parameter and Signal Property Values

Class:
Parameter,
Signal, or Both

Property Available Property
Values
(* Indicates Default)

Description

Parameter Value *0 The data type and numeric value of the data
object. For example, int8(5). The numeric
value is used as an initial parameter value in
the generated code.

Both Data type  Used to specify the data type for an
mpt.Signal data object, but not for an
mpt.Parameter data object. The data type for
an mpt.Parameter data object is specified in
the Value field above. See “About Data Types
in Simulink”.

Both Unit *null Units of measurement of the signal or
parameter. (Enter text in this field.)

Both Dimensions *-1 The dimension of the signal or parameter. For
a parameter, the dimension is derived from its
value.

Both Complexity *auto

real

complex

Complexity specifies whether the signal or
parameter is a real or complex number. Select
auto for the code generator to decide. For a
parameter, the complexity is derived from its
value.

Signal Sample time *-1 Model or block execution rate.
Signal Sample mode *auto Determines how the signal propagates through

the model. Select auto for the code generator
to decide.

  Sample based The signal propagates through the model one
sample at a time.

  Frame based The signal propagates through the model in
batches of samples.

Both Minimum *0.0 The minimum value to which the parameter or
signal is expected to be bound.

  Number within the
minimum range of the
parameter or signal.
(Based on the data type
and resolution of the
parameter or signal.)

 

Both Maximum *0.0 Maximum value to which the parameter or
signal is expected to be bound. (Enter
information using a dialog box.)

 Code generation
options
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Class:
Parameter,
Signal, or Both

Property Available Property
Values
(* Indicates Default)

Description

 Storage class  Note that an auto selection for a storage class
tells the build process to decide how to declare
and store the selected parameter or signal.

Both Global (Custom) Global is the default
storage class for mpt
data objects.

Specifies that a code generator not place a
qualifier in the data object's declaration.

Both Memory section *Default Memory section allows you to specify storage
directives for the data object. Default
specifies that the code generator not place a
type qualifier and pragma statement with the
data object's declaration.

Parameter  MemConst Places the const type qualifier in the
declaration.

Both  MemVolatile Places the volatile type qualifier in the
declaration.

Parameter  MemConstVolatile Places the const volatile type qualifier in
the declaration.

Both Header file  Name of the file used to import or export the
data object. This file contains the declaration
(extern) to the data object.

Also, you can specify this header filename
between the double-quotation or angle-bracket
delimiter. You can specify the delimiter with or
without the .h extension. For example, specify
"object.h" or "object". For the selected
data object, this overrides the general
delimiter selection in the #include file
delimiter field on the Configuration
Parameters dialog box.

Both Owner *Blank The name of the module that owns this signal
or parameter. This is used to help determine
the ownership of a definition. For details, see
“Control Placement of Global Data Definitions
and Declarations in Generated Files” on page
35-2.

Both Definition file *Blank Name of the file that defines the data object.
  Valid character vector  
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Class:
Parameter,
Signal, or Both

Property Available Property
Values
(* Indicates Default)

Description

Both Persistence level  The number you specify is relative to Signal
display level or Parameter tune level on the
Code Placement pane of the Configuration
Parameters dialog box. For a signal, allows you
to specify whether or not the code generator
declares the data object as global data. For a
parameter, allows you to specify whether or
not the code generator declares the data
object as tunable global data. See Signal
display level and Parameter tune level in
“Model Configuration Parameters: Code
Generation Code Placement”.

Both Bitfield (Custom)  Embeds Boolean data in a named bit field.
 Struct name Name of the struct into which the object's

data will be packed.
Parameter Const (Custom)  Places the const type qualifier in the

declaration.
Parameter Header file  See above.
Parameter Owner  See above.
Parameter Definition  file  See above.
Parameter Persistence  level  See above.
Both Volatile (Custom)  Places the volatile type qualifier in the

declaration.
Both Header file  See above.
Both Owner  See above.
Both Definition  file  See above.
Both Persistence  level  See above.
Parameter ConstVolatile

(Custom)
 Places the const volatile type qualifier in

declaration.
Parameter Header file  See above.
Parameter Owner  See above.
Parameter Definition  file  See above.
Parameter Persistence  level  See above.
Parameter Define (Custom)  Represents parameters with a #define macro.
Parameter Header file  See above.
Both ExportToFile

(Custom)
 Generates global variable definition, and

generates a user-specified header (.h) file that
contains the declaration (extern) to that
variable.

Both Memory  section  See above.
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Class:
Parameter,
Signal, or Both

Property Available Property
Values
(* Indicates Default)

Description

Both Header file  See above.
Both Definition  file  See above.
Both ImportFromFile

(Custom)
 Includes predefined header files containing

global variable declarations, and places the
#include in a corresponding file. Assumes
external code defines (allocates memory) for
the global variable.

Both Data access *Direct Allows you to specify whether the identifier
that corresponds to the selected data object
stores data of a data type (Direct) or stores
the address of the data (a pointer).

Both  Pointer If you select Pointer, the code generator
places * before the identifier in the generated
code.

 Header file  See above.
Both Struct (Custom)  Embeds data in a named struct to

encapsulate sets of data.
Both Struct name  See above.
Signal GetSet (Custom)  Reads (gets) and writes (sets) data using

functions.
Signal Header file  See above.
Signal Get function  Specify the Get function.
Signal Set function  Specify the Set function.
Both Alias *null As explained in detail in “Override Data Object

Naming Rules” on page 53-12, for a Simulink
or mpt data object (identifier), specifying a
name in the Identifier field overrides the
global naming rule selection you make on the
Configuration Parameters dialog box.

  Valid ANSIa C/C++
variable name

 

Both Description *null Text description of the parameter or signal.
Appears as a comment beside the signal or
parameter's identifier in the generated code.

  Character vector  
Signal Reusable  Allows the code generator to reuse a pair of

root I/O signals when you specify the same
name and the same storage class for both. The
storage class is either Reusable or derived
from Reusable.
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Class:
Parameter,
Signal, or Both

Property Available Property
Values
(* Indicates Default)

Description

Signal Data Scope *Auto You can specify the scope of symbols code
generation generates for a data object of this
class by selecting a value for DataScope.
When you take the default of Auto, code
generation determines the symbol scope
internally. If possible, symbols have File
scope. Otherwise, they have Exported scope.

  File Code generation defines the scope of each
symbol as the file that defines it. File scope
requires each symbol to be used in a single
file. If the same symbol is referenced in
multiple files, code generation reports an
error.

  Exported Code generation exports symbols to external
code in the header file specified by the
HeaderFile field. If a HeaderFile is not
specified, symbols are exported to external
code in model.h.

  Imported Code generation imports symbols from
external code in the header file specified by
the HeaderFile field. If you do not specify a
header file, code generation generates an
extern directive in model_private.h.

Signal Header file  See above.
Signal Owner  See above.
Signal Definition  file  See above.
a. ANSI is a registered trademark of the American National Standards Institute, Inc.

 MPT Data Object Properties

37-7



mpt Package Storage Classes

CSC Name Purpose Signals? Parameters?
BitField Generate a struct declaration that

embeds Boolean data in named bit
fields.

Y Y

CompilerFlag Supports preprocessor conditionals
defined via compiler flag. See
“Generate Preprocessor Conditionals
for Variant Systems” on page 26-31.

N Y

Const Generate a constant declaration with
the const type qualifier.

N Y

ConstVolatile Generate declaration of volatile
constant with the const volatile
type qualifier.

N Y

Define Generate #define directive. Y Y
ExportToFile Generate header (.h) file, with user-

specified name, containing global
variable declarations.

Y Y

FileScope Generate a static qualifier suffix for a
variable declaration so that the scope
of the variable is limited to the current
file.

Y Y

GetSet Supports specialized function calls to
read and write the memory associated
with a Data Store Memory block. See
“Access Data Through Functions with
Storage Class GetSet” on page 38-26.

Y Y

Global The default storage class for the mpt
package. Generate the declaration and
definition of a data object in specified
files, and use the specified memory
section.

Y Y

ImportedDefine Supports preprocessor conditionals
defined via legacy header file. See
“Generate Preprocessor Conditionals
for Variant Systems” on page 26-31.

N Y

ImportFromFile Generate directives to include
predefined header files containing
global variable declarations.

Y Y

Reusable Allows the code generator to reuse a
pair of root I/O signals when you
specify the same name and the same
storage class for both. The storage
class is either Reusable or derived
from Reusable.

Y N
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CSC Name Purpose Signals? Parameters?
Struct Generate a struct declaration

encapsulating parameter or signal
object data.

Y Y

StructConst Generate a struct declaration, with a
const type qualifier, encapsulating
parameter object data.

N Y

StructVolatile Generate a struct declaration, with a
volatile type qualifier, encapsulating
parameter or signal object data.

Y Y

Volatile Use volatile type qualifier in
declaration.

Y Y
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Examples of Property Value Changes on Generated Code

What I noticed when inspecting
the .c/.cpp file

Change I made to property value
settings

What I noticed after
regenerating and reinspecting
the file

Example 1:
Parameter data objects can be
declared or defined as constants. I
know that the data object GAIN is a
parameter. I want this to be
declared or defined in the .c file as
a variable. But I notice that GAIN is
declared as a constant by the
statement const real_T GAIN =
5.0;. Also, this statement is in the
constant section of the file.

In the Model Explorer, I clicked the
data object GAIN. I noticed that the
property value for its Memory section
property is set at MemConst. I changed
this to Default.

I notice two differences. One is
that now GAIN is declared as a
variable with the statement
real_T GAIN = 5.0;. The
second difference is that the
declaration now is located in the
MemConst memory section in
the .c or .cpp file.

Example 2:
I notice again the declaration of
GAIN in the .c file mentioned in
Example 1. It appears as real_T
GAIN = 5.0;. But I have changed
my mind. I want data object GAIN
to be #define.

I changed the Storage class selection
to Define.

GAIN is not declared in the .c
file as a MemConst parameter.
Rather, it is defined as a
#define macro by the code
#define GAIN 5.0, and this is
located near the top of the .c file
with the other preprocessor
directives.

Example 3:
I changed my mind again after
doing Example 2. I do want GAIN
defined using the #define
preprocessor directive. But I do not
want to include the #define in this
file. I know it exists in another file
and I want to reference that file.

On the Model Explorer, I notice that
the property value for the Header file
property is blank. I changed this to
filename.h. (I chose the ANSI C/C+
+ double quote mechanism for the
#include, but could have chosen the
angle bracket mechanism.) Also, I must
make the user-defined filename.h
available to the compiler, placing it
either in the system path or local
directory.

#define GAIN 5.0 is not
present in this .c file. Instead,
the #include filename.h
code appears as a preprocessor
directive at the top of the file.

Example 4:
I have one more change I want to
make. Let us say that we have
declared the data object data_in,
and that its declaration statement
in the .c file reads
real_T data_in = 0.0;. I want
to replace this statement with an
alias in the .c file.

In the Model Explorer, I selected the
data object data_in. I noticed that the
Identifier field is blank. I changed this
to data_in_alias, which I know is a
valid ANSI C/C++ variable name.

The identifier
data_in_alias now appears in
the .c file everywhere data_in
appeared.

Specify Persistence Level for Signals and Parameters
With this procedure, you can control the persistence level of signal and parameter objects associated
with a model. Persistence level allows you to make intermediate variables or parameters global
during initial development. At the later stages of development, you can use this procedure to remove
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these signals and parameters for efficiency. Use the Persistence Level property of mpt.Signal and
mpt.Parameter data objects. For descriptions of the properties on the Model Explorer, see “MPT
Data Object Properties” on page 37-2.

Notice also the Signal display level and Parameter tune level fields on the Code Placement pane
of the Configuration Parameters dialog box, as illustrated in the next figure.

The Signal display level field allows you to specify whether or not the code generator defines a
signal data object as global data in the generated code. The number you specify in this field is relative
to the number you specify in the Persistence level field. The Signal display level number is for mpt
(module packaging tool) signal data objects in the model. The Persistence level number is for a
particular mpt signal data object. If the data object's Persistence level is equal to or less than the
Signal display level, the signal appears in the generated code as global data with the custom
attributes that you specified. For example, this would occur if Persistence level is 2 and Signal
display level is 5.

Otherwise, the code generator automatically determines how the particular signal data object
appears in the generated code. Depending on the settings on the Optimization pane of the
Configuration Parameters dialog box, the signal data object could appear in the code as local data
without the custom attributes you specified for that data object. Or, based on expression folding, the
code generator could remove the data object so that it does not appear in the code.
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The Parameter tune level field allows you to specify whether or not the code generator declares a
parameter data object as tunable global data in the generated code.

The number you specify in this field is relative to the number you specify in the Persistence level
field. The Parameter tune level number is for mpt parameter data objects in the model. The
Persistence level number is for a particular mpt parameter data object. If the data object's
Persistence level is equal to or less than the Parameter tune level, the parameter appears tunable
in the generated code with the custom attributes that you specified. For example, this would occur if
Persistence level is 2 and Parameter tune level is 5.

Otherwise, the parameter is inlined in the generated code, and the code generation settings
determine its exact form.

Note that, in the initial stages of development, you might be more concerned about debugging than
code size. Or, you might want one or more particular data objects to appear in the code so that you
can analyze intermediate calculations of an equation. In this case, you might want to specify the
Parameter tune level (Signal display level for signals) to be higher than Persistence level for
some mpt parameter (or signal) data objects. This results in larger code size, because the code
generator defines the parameter (or signal) data objects as global data, which have the custom
properties you specified. As you approach production code generation, however, you might have more
concern about reducing the size of the code and less need for debugging or intermediate analyses. In
this stage of the tradeoff, you could make the Parameter tune level (Signal display level for
signals) greater than Persistence level for one or more data objects, generate code and observe the
results. Repeat until satisfied.

1 With the model open, in the Configuration Parameters dialog box, select Code Generation >
Code Placement.

2 Type the desired number in the Signal display level or Parameter tune level field, and click
Apply.

3 In the Model Explorer, type the desired number in the Persistence field for the selected signal or
parameter, and click Apply.

4 Save the model and generate code.
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Reuse Parameter Data from External Code in the Generated
Code

This example shows how to generate code that imports a parameter value from your external code.

Create External Code Files

Suppose your external code defines a vector parameter myGains with three elements. Save the
definition in your current folder in a file called ex_vector_import_src.c.

#include "ex_vector_import_decs.h"

my_int8 myGains[3] = {
    2,
    4,
    6
}; 

Save the declaration in your current folder in a file called ex_vector_import_decs.h.

#include "ex_vector_import_cust_types.h"

extern my_int8 myGains[3];  

Save the data type definition my_int8 in your current folder in a file called
ex_vector_import_cust_types.h.

typedef signed char my_int8;

Import Parameter Value for Simulation

In your current folder, right-click the file ex_vector_import_src.c and select Import Data.

In the Import dialog box, set Output Type to Numeric Matrix.

Set the name of the generated MATLAB variable to tempVar.

Select only the parameter values (2, 4, and 6) to import.
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Import the data by clicking the green check mark. The MATLAB variable tempVar appears in the
base workspace.

Alternatively, use the command prompt to manually create tempVar.

tempVar = [2;4;6];

At the command prompt, create a Simulink.Parameter object that represents myGains.

myGains = Simulink.Parameter(tempVar);

Create and Configure Model

Create the model ex_vector_import.

open_system('ex_vector_import')

Open the Embedded Coder app.

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, inspect the Parameters tab.

Use the Value column to set the value of the Gain parameter in the Gain block to myGains.

Click the Show/refresh additional information button. The data table now contains a row that
represents the parameter object, myGains.

Use the Data Type column to set the data type of myGains to my_int8.

For the other row (which represents the Gain parameter of the Gain block), set Data Type to
Inherit: Inherit from 'Gain'. With this setting, the Gain parameter inherits the data type
my_int8 from myGains.

Set the Change view drop-down list to Code.

Set these properties for myGains:

• Storage Class to ImportFromFile
• Header File to ex_vector_import_decs.h

Alternatively, use these commands at the command prompt to configure the object and the block:

set_param('ex_vector_import/Gain','Gain','myGains',...
    'ParamDataTypeStr','Inherit: Inherit from ''Gain''')
myGains.DataType = 'my_int8';
myGains.CoderInfo.StorageClass = 'Custom';
myGains.CoderInfo.CustomStorageClass = 'ImportFromFile';
myGains.CoderInfo.CustomAttributes.HeaderFile = 'ex_vector_import_decs.h';
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At the command prompt, create a Simulink.AliasType object to represent your custom data type
my_int8. Set the DataScope and HeaderFile properties to import the type definition from your
external code.

my_int8 = Simulink.AliasType('int8');
my_int8.DataScope = 'Imported';
my_int8.HeaderFile = 'ex_vector_import_cust_types.h';

Set model configuration parameter Source files to ex_vector_import_src.c.

set_param('ex_vector_import','CustomSource','ex_vector_import_src.c')

Generate and Inspect Code

Generate code.

slbuild('ex_vector_import')

### Starting build procedure for: ex_vector_import
### Successful completion of build procedure for: ex_vector_import

Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
ex_vector_import  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.778s

The generated file ex_vector_import.h includes the external header files
ex_vector_import_decs.h and ex_vector_import_cust_types.h, which contain the
parameter variable declaration (myGains) and custom type definition (my_int8).

file = fullfile('ex_vector_import_ert_rtw','ex_vector_import.h');
rtwdemodbtype(file,'#include "ex_vector_import_cust_types.h"',...
    '#include "ex_vector_import_cust_types.h"',1,1)
rtwdemodbtype(file,'/* Includes for objects with custom storage classes. */',...
    '#include "ex_vector_import_decs.h"',1,1)

#include "ex_vector_import_cust_types.h"

/* Includes for objects with custom storage classes. */
#include "ex_vector_import_decs.h"

The generated code algorithm in the model step function in the generated file
ex_vector_import.c uses myGains for calculations.

file = fullfile('ex_vector_import_ert_rtw','ex_vector_import.c');
rtwdemodbtype(file,'/* Model step function */','/* Model initialize function */',1,0)

/* Model step function */
void ex_vector_import_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
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   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/In1'
   */
  rtY.Out1[0] = (real_T)myGains[0] * rtU.In1;
  rtY.Out1[1] = (real_T)myGains[1] * rtU.In1;
  rtY.Out1[2] = (real_T)myGains[2] * rtU.In1;
}

The generated code does not define (allocate memory for) or initialize the global variable myGains
because the data scope of the corresponding parameter object is imported.

When you simulate the model in Simulink, the model uses the value stored in the Value property of
the parameter object. However, if you use external mode simulation, the external executable begins
the simulation by using the value from your code. See “Considerations for Other Modeling Goals” on
page 56-75.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Import Parameter Data with Conditionally Compiled Dimension Length” on page 38-6
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Import Parameter Data with Conditionally Compiled Dimension
Length

Suppose your external code conditionally allocates memory for and initializes lookup table and
breakpoint set data based on a dimension length that you specify as a #define macro. This example
shows how to generate code that imports this external global data.

Create External Code Files

Save the definition of the breakpoint set data T1Break and lookup table data T1Data in your current
folder in a file called ex_vec_symdim_src.c. These global variables have either 9 or 11 elements
depending on the value of the macro bpLen.

#include "ex_vec_symdim_decs.h"

#if bpLen == 11
double T1Break[bpLen] = { 
    -5.0, 
    -4.0, 
    -3.0, 
    -2.0, 
    -1.0, 
    0.0, 
    1.0, 
    2.0, 
    3.0, 
    4.0, 
    5.0 
} ;
    
double T1Data[bpLen] = { 
    -1.0, 
    -0.99, 
    -0.98, 
    -0.96, 
    -0.76, 
    0.0, 
    0.76, 
    0.96, 
    0.98, 
    0.99, 
    1.0 
} ; 
#endif

#if bpLen == 9
double T1Break[bpLen] = { 
    -4.0, 
    -3.0, 
    -2.0, 
    -1.0, 
    0.0, 
    1.0, 
    2.0, 
    3.0, 
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    4.0
} ;
    
double T1Data[bpLen] = { 
    -0.99, 
    -0.98, 
    -0.96, 
    -0.76, 
    0.0, 
    0.76, 
    0.96, 
    0.98, 
    0.99
} ; 
#endif

Save the declarations of the variables and the definition of the macro in your current folder in file
ex_vec_symdim_decs.h.

#define bpLen 11

extern double T1Break[bpLen];  
extern double T1Data[bpLen];

Explore and Configure Example Model

Open the example model rtwdemo_configinterface.

open_system('rtwdemo_configinterface')
set_param('rtwdemo_configinterface/Table1','DataSpecification','Table and breakpoints');
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Open the Table1 block dialog box. The block refers to variables, T1Data and T1Break, in the model
workspace. These variables store the lookup table and breakpoint set data with 11 elements.

At the command prompt, convert the variables to Simulink.Parameter objects.

mws = get_param('rtwdemo_configinterface','modelworkspace');
T1Data = mws.getVariable('T1Data');
T1Break = mws.getVariable('T1Break');
T1Data = Simulink.Parameter(T1Data);
T1Break = Simulink.Parameter(T1Break);

At the command prompt, create a Simulink.Parameter object to represent the custom macro
bpLen.

bpLen = Simulink.Parameter(11);
bpLen.Min = 9;
bpLen.Max = 11;
bpLen.DataType = 'int32';
bpLen.CoderInfo.StorageClass = 'Custom';
bpLen.CoderInfo.CustomStorageClass = 'ImportedDefine';
bpLen.CoderInfo.CustomAttributes.HeaderFile = 'ex_vec_symdim_decs.h';

Use bpLen to set the dimensions of the lookup table and breakpoint set data. Configure the model to
enable symbolic dimensions by selecting the configuration parameter Allow symbolic dimension
specification.
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T1Data.Dimensions = '[1 bpLen]';
T1Break.Dimensions = '[1 bpLen]';
set_param('rtwdemo_configinterface','AllowSymbolicDim','on');

Set Configuration Parameters > Code Generation > Custom Code > Additional build
information > Source files to ex_vec_symdim_src.c.

set_param('rtwdemo_configinterface','CustomSource','ex_vec_symdim_src.c')

Configure the objects to import the data definitions from your external code.

mws.assignin('T1Data',T1Data);
mws.assignin('T1Break',T1Break);
cm = coder.mapping.utils.create('rtwdemo_configinterface');
setDataDefault(cm,'ModelParameters','StorageClass','Default');
setModelParameter(cm,'Table1','StorageClass','Model default');
setModelParameter(cm,'Table2','StorageClass','Model default');
setModelParameter(cm,'T1Data','StorageClass','ImportFromFile','HeaderFile','ex_vec_symdim_decs.h');
setModelParameter(cm,'T1Break','StorageClass','ImportFromFile','HeaderFile','ex_vec_symdim_decs.h');

Generate and Inspect Code

Generate code from the model.

The generated code algorithm is in the model step function in the generated file
rtwdemo_configinterface.c. The algorithm passes T1Break, T1Data, and bpLen as argument
values to the function that performs the table lookup. In this case, bpLen controls the upper bound of
the binary search that the function uses.

For more information about symbolic dimensions, see “Implement Dimension Variants for Array Sizes
in Generated Code” on page 26-2.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Reuse Parameter Data from External Code in the Generated Code” on page 38-2
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Access Structured Data Through a Pointer That External Code
Defines

This example shows how to generate code that uses global data that some handwritten code defines.
In the handwritten code, a pointer variable points to one of three structure variables that contain
parameter data. A handwritten function switches the pointer between the structures. The generated
code accesses the parameter data by dereferencing the pointer variable.

Explore External Code

Open the example source file rtwdemo_importstruct_user.c. The code defines a default data
structure variable ReferenceStruct as constant (const) data and statically initializes each field.
This structure represents the reference data set.

/* Constant default data structure (reference data set) */
const DataStruct_type ReferenceStruct = 
{
  11,   /* OFFSET */
  2     /* GAIN */
};

The code defines two other structure variables, WorkingStruct1 and WorkingStruct2, as volatile
(volatile) data.

/* Volatile data structures (working data sets) */
volatile DataStruct_type WorkingStruct1;
volatile DataStruct_type WorkingStruct2;

The code defines a function that can initialize:

• An inactive working structure from the active working structure.
• Both working structures from the reference structure.

/* Function to initialize inactive working structures from active structure */
void InitInactiveWorkingStructs(void)
{
    if (StructPointer == &WorkingStruct1) {
        /* Copy values from WorkingStruct1 to WorkingStruct2 */
        memcpy((void*)&WorkingStruct2, (void*)&WorkingStruct1, sizeof(ReferenceStruct));
        
    } else if (StructPointer == &WorkingStruct2) {
        /* Copy values from WorkingStruct2 to WorkingStruct1 */
        memcpy((void*)&WorkingStruct1, (void*)&WorkingStruct2, sizeof(ReferenceStruct));
        
    } else {
        /* Initialize both working structures from ReferenceStruct */
        memcpy((void*)&WorkingStruct1, &ReferenceStruct, sizeof(ReferenceStruct));
        memcpy((void*)&WorkingStruct2, &ReferenceStruct, sizeof(ReferenceStruct));
    }
}

The code defines StructPointer, which is a const volatile pointer to a structure. The code
initializes the pointer to the address of ReferenceStruct.
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/* Define structure pointer.  Point to reference structure by default */
const volatile DataStruct_type *StructPointer = &ReferenceStruct;

Finally, the code defines a function that can dynamically set StructPointer to point to either
ReferenceStruct, WorkingStruct1, or WorkingStruct2.

/* Function to switch between structures */
void SwitchStructPointer(Dataset_T Dataset)
{
    switch (Dataset) {
    case Working1:
        StructPointer = &WorkingStruct1;
        break;
    case Working2:
        StructPointer = &WorkingStruct2;
        break;
    default:
        StructPointer = &ReferenceStruct;
    }
}

The example header file rtwdemo_importstruct_user.h defines the enumeration Dataset_T and
the structure type Datastruct_type. The file includes (#include) the built-in Simulink® Coder™
header file rtwtypes.h, which defines (typedef) Simulink Coder data types such as int16_T.

#include "rtwtypes.h"

typedef enum {
    Reference = 0,
    Working1,
    Working2
} Dataset_T;

typedef struct DataStruct_tag {
  int16_T   OFFSET; /* OFFSET */
  int16_T   GAIN;   /* GAIN */
} DataStruct_type;

The file also declares the global variables and the functions.

Purpose of External Code

The code is designed so that the source code of a control algorithm (whether generated or
handwritten) can read data from ReferenceStruct, WorkingStruct1, or WorkingStruct2 by
dereferencing (->) StructPointer. The two working structures (WorkingStruct1 and
WorkingStruct2) are located in volatile memory and are intended to be changed during runtime by
an external calibration tool. The calibration engineer does not change the active working structure.
Instead, the engineer changes the parameter values in the inactive working structure and then
activates it by switching working structures.

If necessary for safety or in preparation for shutting down the application, the calibration tool can
point StructPointer to ReferenceStruct instead. ReferenceStruct stores default parameter
values that do not change during execution.
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Explore Example Model

Open the example model, rtwdemo_importstruct.

The model creates variables and objects in the base workspace. The Constant block and the Gain
block use the ECoderDemos.Parameter objects GAIN and OFFSET to set the Constant value and
Gain block parameters. ECoderDemos is an example custom package that defines two classes,
Parameter and Signal, and some custom storage classes.

On the Modeling tab, click Model Data Editor.

In the Model Data Editor, inspect the Parameters tab.

Set the Change view drop-down list to Code.

Click the Show/refresh additional information button.

The Model Data Editor shows rows that correspond to the Constant value and Gain parameters of
the blocks and rows that corresponds to OFFSET and GAIN, which set the parameter values. In the
Storage Class column, OFFSET and GAIN use the custom storage class StructPointer, which the
ECoderDemos package defines.

Open the Custom Storage Class Designer and inspect the custom storage classes in the
ECoderDemos package. At the command prompt, use this command:

cscdesigner('ECoderDemos')

This example package defines multiple custom storage classes, including StructPointer. You
cannot edit the definitions. However, you can create your own packages and custom storage classes
later. For an example that shows how to create a package and a custom storage class, see “Create
and Apply a Storage Class” on page 38-15.

Under Custom storage class definitions, click StructPointer. The settings for this custom
storage class enable the generated code to interact with the pointer variable, StructPointer, from
the external code. For example, the custom storage class uses these settings:

• Data scope is set to Imported because the example external code defines (allocates memory for)
StructPointer. With this setting, the code generator avoids generating unnecessary, duplicate
definitions for the data items, such as the ECoderDemos.Parameter objects, that use the custom
storage class.
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• Data access is set to Pointer because in the example external code, StructPointer is a
pointer.

• Memory section is set to ConstVolatile because the example external code defines
StructPointer as constant, volatile data (const volatile).

• Type is set to FlatStructure because in the example external code, StructPointer points to a
structure. With this setting, the generated code treats each data item (ECoderDemos.Parameter
object) as a field of a flat structure whose variable name and type name you can specify.

• On the Structure Attributes tab, Struct name is set to StructPointer. For a FlatStructure
custom storage class, Struct name specifies the name of the structure variable in the generated
code. In this example, StructPointer is the name of the variable that the external code defines.

• Type name is set to DataStruct_type, which is the name of the structure type that the example
external code defines.

In the model, in the Configuration Parameters dialog box, inspect the Code Generation >
Custom Code pane.

Under Insert custom C code in generated, select Initialize function. This parameter value
specifies the code to include in the generated model initialize function. In this model, the
configuration parameter is set so that the generated code calls the InitInactiveWorkingStructs
function. InitInactiveWorkingStructs initializes the working structures with the values from
ReferenceStruct. The initialization code then sets the pointer to the first working structure.

Under Additional build information, select Source files. This configuration parameter identifies
the example external code file rtwdemo_importstruct_user.c for inclusion in the build process
after code generation.

Generate and Inspect Code

Generate code from the model.

In the generated file rtwdemo_importstruct.c, the model initialization function calls
InitInactiveWorkingStructs.

/* Model initialize function */
void rtwdemo_importstruct_initialize(void)
{
  /* user code (Initialize function Body) */

  /* Initialize the working structures to reference values */
  InitInactiveWorkingStructs();

  /* Switch to first working structure */
  SwitchStructPointer(Working1);
}

/*

The algorithm in the model execution (step) function dereferences the pointer variable
StructPointer.

/* Model step function */
void rtwdemo_importstruct_step(void)
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{
  /* Outport: '<Root>/Out' incorporates:
   *  Constant: '<Root>/Offset'
   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/In'
   *  Sum: '<Root>/Sum'
   */
  Sensor_Out = (int16_T)((int16_T)(Sensor_In - StructPointer->OFFSET) *
    StructPointer->GAIN);
}

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Create Tunable Calibration Parameter in the Generated Code” on page 34-109
• “Switch Between Sets of Parameter Values During Simulation and Code Execution” on page 34-

159
• “Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15
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Create Storage Classes by Using the Custom Storage Class
Designer

To control the appearance of data in the generated code, you can use built-in storage classes such as
ExportToFile (see “Organize Parameter Data into a Structure by Using Struct Storage Class” on
page 33-68). If the built-in storage classes do not meet your requirements, you can create your own
storage classes. To create a storage class that you can apply to data objects, create the storage class
in a package by using the Custom Storage Class Designer. See “Define Storage Classes, Memory
Sections, and Function Templates for Software Architecture” on page 31-2.

To define a storage class that you can apply in a model by using the Code Mappings editor, use the
Embedded Coder Dictionary. Or, create the storage class in a package and refer to the package
from the Embedded Coder Dictionary.

A package also defines Signal and Parameter data classes. See “Data Objects”. A data object from
a package such as Simulink can use storage classes defined in that package but not storage classes
that are defined in other packages.

For information about using the Custom Storage Class Designer to create memory sections, see
“Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2.

Create and Apply a Storage Class
This example shows how to control code generated from a model by creating and applying your own
storage class for data objects.

Explore Example Model

Open the model rtwdemo_cscpredef. You can control code generated from this model by defining your
own data classes and creating your own storage classes.

In this example, you export the declarations and definitions of multiple signals and parameters in the
model to one declaration header file and one definition file.

Create Data Class Package

To create storage classes, you first create a data class package to contain the storage class
definitions. Data objects that you create from your package can use the storage classes that the
package defines.

1 Create your own data class package by copying the example package folder +SimulinkDemos.
Navigate to the example package folder.

% Remember the current folder path
currentPath = pwd;

% Navigate to the example package folder
demoPath = '\toolbox\simulink\simdemos\dataclasses';
cd([matlabroot,demoPath])

2 Copy the +SimulinkDemos folder to your clipboard.
3 Return to your working folder.

cd(currentPath)
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4 Paste the +SimulinkDemos folder from your clipboard into your working folder. Rename the
copied folder to +myPackage.

5 Navigate inside the +myPackage folder to the file Signal.m to edit the definition of the Signal
class.

6 Uncomment the methods section that defines the method setupCoderInfo. In the call to the
function useLocalCustomStorageClasses, replace 'packageName' with 'myPackage'.
When you finish, the section appears as follows:

  methods
    function setupCoderInfo(h)
      % Use custom storage classes from this package
      useLocalCustomStorageClasses(h, 'myPackage');
    end
  end % methods

The function useLocalCustomStorageClasses allows you to apply the storage classes that
myPackage defines to data objects that you create from myPackage.

7 Save and close the file.
8 Navigate inside the +myPackage folder to the file Parameter.m to edit the definition of the

Parameter class. Uncomment the methods section that defines the method setupCoderInfo
and replace 'packageName' with 'myPackage'.

9 Save and close the file.

Create Storage Class

You can use the Custom Storage Class Designer to create or to edit the storage classes that a data
class package defines.

1 Set your current folder to the folder that contains the package myPackage.
2 Open the Custom Storage Class Designer.

cscdesigner('myPackage')
3 Select the storage class ExportToFile.
4 In the Name field, rename the storage class to ExportToGlobal.
5 In the Header file drop-down list, change the selection from Instance specific to Specify.

In the new field, provide the header file name global.h.
6 In the Definition file drop-down list, change the selection from Instance specific to

Specify. In the new field, provide the definition file name global.c.
7 Click OK. Click Yes to save changes to the data class package myPackage.

Apply Storage Class

To apply your own storage class, you create data objects from your package and configure the objects
to use your storage class.

1 Create data objects to represent some of the parameters and signals in the example model.
Create the objects using the data class package myPackage.

% Parameters
templimit = myPackage.Parameter(202);
pressurelimit = myPackage.Parameter(45.2);
O2limit = myPackage.Parameter(0.96);
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rpmlimit = myPackage.Parameter(7400);

% Signals
tempalarm = myPackage.Signal;
pressurealarm = myPackage.Signal;
O2alarm = myPackage.Signal;
rpmalarm = myPackage.Signal;

2 Set the storage class of each object to ExportToGlobal.

% Parameters
templimit.CoderInfo.StorageClass = 'Custom';
templimit.CoderInfo.CustomStorageClass = 'ExportToGlobal';
pressurelimit.CoderInfo.StorageClass = 'Custom';
pressurelimit.CoderInfo.CustomStorageClass = 'ExportToGlobal';
O2limit.CoderInfo.StorageClass = 'Custom';
O2limit.CoderInfo.CustomStorageClass = 'ExportToGlobal';
rpmlimit.CoderInfo.StorageClass = 'Custom';
rpmlimit.CoderInfo.CustomStorageClass = 'ExportToGlobal';

% Signals 
tempalarm.CoderInfo.StorageClass = 'Custom';
tempalarm.CoderInfo.CustomStorageClass = 'ExportToGlobal';
pressurealarm.CoderInfo.StorageClass = 'Custom';
pressurealarm.CoderInfo.CustomStorageClass = 'ExportToGlobal';
O2alarm.CoderInfo.StorageClass = 'Custom';
O2alarm.CoderInfo.CustomStorageClass = 'ExportToGlobal';
rpmalarm.CoderInfo.StorageClass = 'Custom';
rpmalarm.CoderInfo.CustomStorageClass = 'ExportToGlobal';

3 Select the Signal name must resolve to Simulink signal object option for each of the target
signals in the model. You can select the option by using the Signal Properties dialog box, the
Resolve column in the Model Data Editor, or by using the command line.

% Signal tempalarm
portHandles = get_param('rtwdemo_cscpredef/RelOp1','PortHandles');
outputPortHandle = portHandles.Outport;
set_param(outputPortHandle,'MustResolveToSignalObject','on')

% Signal pressurealarm
portHandles = get_param('rtwdemo_cscpredef/RelOp2','PortHandles');
outputPortHandle = portHandles.Outport;
set_param(outputPortHandle,'MustResolveToSignalObject','on')

% Signal O2alarm
portHandles = get_param('rtwdemo_cscpredef/RelOp3','PortHandles');
outputPortHandle = portHandles.Outport;
set_param(outputPortHandle,'MustResolveToSignalObject','on')

% Signal rpmalarm
portHandles = get_param('rtwdemo_cscpredef/RelOp4','PortHandles');
outputPortHandle = portHandles.Outport;
set_param(outputPortHandle,'MustResolveToSignalObject','on')

Generate Code

1 Generate code for the example model.

slbuild('rtwdemo_cscpredef')
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2 In the Code view for the model, view the generated header file global.h. The file contains the
extern declarations of the model signals and parameters that use the storage class
ExportToGlobal.

/* Declaration for custom storage class: ExportToGlobal */
extern boolean_T O2alarm;
extern real_T O2limit;
extern boolean_T pressurealarm;
extern real_T pressurelimit;
extern boolean_T rpmalarm;
extern real_T rpmlimit;
extern boolean_T tempalarm;
extern real_T templimit;

3 View the generated file global.c. The file contains the definitions of the model signals and
parameters that use the storage class ExportToGlobal.

/* Definition for custom storage class: ExportToGlobal */
boolean_T O2alarm;
real_T O2limit = 0.96;
boolean_T pressurealarm;
real_T pressurelimit = 45.2;
boolean_T rpmalarm;
real_T rpmlimit = 7400.0;
boolean_T tempalarm;
real_T templimit = 202.0;

Modify a Built-In Storage Class
You cannot directly modify a built-in storage class, such as ExportToFile from the Simulink
package, but you can create a copy, and then modify the copy. When you create a new package with
no csc_registration.m file, and then open the Custom Storage Class Designer for the first time in
that package, Simulink copies the definitions of the built-in storage classes into the package. Then, in
the Custom Storage Class Designer, you can modify the copied definitions. Alternatively, to keep the
built-in storage classes available in your package, copy one of them by clicking Copy, then modify the
resulting copy.

Control Data Representation by Configuring Storage Class Properties
The Custom Storage Class Designer is a tool for creating and managing storage classes and memory
sections. To open the Custom Storage Class Designer for a specific package, for example, +mypkg, at
the command prompt, use the cscdesigner function:

cscdesigner('mypkg')

The name of the folder that represents a package begins with a +. When you use the function
cscdesigner, omit the + from the name of the target package.

To control the effect that a storage class has on data in a model, you specify properties of the storage
class in the Custom Storage Class Designer. To determine how to generate a particular kind of code,
use the information in the table.
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Kind of Data in Generated Code Technique
Structure Set Type to FlatStructure. See “Generate

Structured Data” on page 38-20.
Macro Set Data initialization to Macro and clear For

signals. See “Generate a Macro” on page 38-19.
Pointer Set Data access to Pointer and Data scope to

Auto, Imported, or Instance specific. Your
external code must define the pointer variable.

static data (file-scoped data) Set Data scope to File.
const or volatile data Set Memory section to a memory section that

specifies const, volatile, or both. For
example, use one of the built-in memory sections
MemConst, MemVolatile, and
MemConstVolatile. To create your own
memory section, see “Control Data and Function
Placement in Memory by Inserting Pragmas” on
page 43-2.

Calls to external functions to read and write to
data

See “Call Custom Accessor Functions or Macros
Instead of Reading and Writing to Variables” on
page 38-20.

Allow Users of Storage Class to Specify Property Value

For some properties of a storage class, such as Data scope, instead of specifying a value in the
Custom Storage Class Designer, you can allow users of the storage class to specify the value. You can
create a single, flexible storage class instead of multiple storage classes that vary only by a few
property values.

For example, suppose you create a storage class that yields a global variable in the generated code.
You can configure the storage class so that a user can set the Data scope property to Exported for a
signal in a model and set the property to Imported for a different signal.

In the Custom Storage Class Designer, for each property that you want to configure in this way, set
the property value to Instance specific. Then, when a user applies the storage class to a data
item, the property appears to the user as a custom attribute for that data item. For information about
instance-specific custom attributes, see “Storage Class Properties” on page 34-74.

Generate a Macro

To create a storage class that yields a macro in the generate code, set Data initialization to Macro
and clear For signals.

When you set Data initialization to Macro, Definition file has no meaning. To prevent users of the
storage class from specifying a meaningless definition file, in the Custom Storage Class Designer, set
Definition file to Specify and leave the text box empty.

• To define the macro in a header file (#define), specify the name of the header file with the
Header file property.

• To provide the macro definition as a compiler option or compiler flag, set Data access to
Imported and Header file to Specify. Leave the Header file text box empty. Then, the
generated code does not define the macro and does not include (#include) a header file.
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To specify the compiler option or flag, use the model configuration parameter Configuration
Parameters > Code Generation > Custom Code > Additional build information > Defines.
See Code Generation Pane: Custom Code: Additional Build Information: Defines.

Generate Structured Data

To create a storage class that aggregates data items into a flat structure (similar to the built-in
storage class Struct), set Type to FlatStructure. The Structure Attributes tab appears.

• To control the name of the global structure variable that appears in the generated code, use the
Struct name property and text box.

• If you set Struct name to Instance specific, users of the storage class specify the name of
the structure variable. In this case, the code generator derives the name of the structure type
from the name of the variable.

To more precisely control the name and other characteristics of the structure type, set Struct
name to Specify. Control the type characteristics by using the additional properties that appear.

• To generate a structure with bit fields (similar to the built-in storage class BitField), select Bit-
pack booleans. Data items that use the data type boolean appear in the generated code as bit
fields of the structure.

Control Assignment of Initial Value in Generated Code

• To use the default Simulink Coder initialization strategy, set Data initialization to the default
value, Auto.

• The generated code statically initializes parameter data with an assignment statement at the
top of a .c or .cpp source file, outside of any function.

• The generated code dynamically initializes signal and state data as part of the initialization
function of the model (named model_initialize by default).

• To statically initialize the data, set Data initialization to Static.
• To dynamically initialize the data, set Data initialization to Dynamic.
• To prevent the generated code from initializing the data, set Data initialization to None. When

your external code initializes the data, use this setting to prevent the generated code from
overwriting your initialization.

Call Custom Accessor Functions or Macros Instead of Reading and Writing to Variables

Using the built-in storage class GetSet, you can generate code that calls your external, custom
functions instead of directly interacting with variables. For general information about GetSet, see
“Access Data Through Functions with Storage Class GetSet” on page 38-26.

To create a similar storage class, set Type to AccessFunction.

• Specify the names of the external functions.

• To apply the same get or set function naming scheme to data items that use the storage class,
set Get function and Set function to Specify. Then, in the text boxes, specify the function
naming scheme, for example, get_myData_$N. Use the token $N in a naming scheme to
represent the name of each data item. If you do not use the token, each data item uses the
same specified get or set function name, so the model generates an error when you generate
code.
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• To specify a different get or set function name for each data item, set Get function or Set
function to Instance specific. Later, when you create a data item and apply the storage
class, specify the function name by configuring the custom attributes of the data item.

• Specify the name of the header file that declares the get and set functions with the Header file
property. In this case, Definition file has no meaning. To prevent users of the storage class from
specifying a meaningless definition file, set Definition file to Specify and leave the text box
empty.

• If you implement the get mechanism for scalar or array data as a macro instead of a function, you
can generate code that omits parentheses when reading that data. On the Access Function
Attributes tab, select Get data through macro (omit parentheses).

Generate Code That Uses Data From External Code

When your external code defines data, to avoid generating a duplicate definition, you must configure
the generated code to read and write to the existing data. In the Custom Storage Class Designer, set
Data scope to Imported. The code generator does not generate a definition for the global variable
or macro.

• If your code defines a pointer variable, to generate code that interacts with the pointer, set Data
access to Pointer.

• If you generate structured data by setting Type to FlatStructure, your code must define the
structure type and the global structure variable.

• If your code initializes state or signal data, you can prevent the generated code from overwriting
your initialization by setting Data initialization to None. See “Prevent Duplicate Initialization
Code for Global Variables” on page 56-78

Generate Code Comments with Data Definitions and Declarations

To customize the comments that appear in the generated code, on the Comments tab, set Comment
rules to Specify. To specify a comment that appears with the declaration of each data item, use the
Declaration comment box. To specify a comment that appears with the definition, use the
Definition comment box.

For structured data (you set Type to FlatStructure), to specify a comment that appears with the
structure type definition, use the Type comment box.

Avoid Errors During Code Generation by Validating Storage Class
Configuration
As you configure a storage class in the Custom Storage Class Designer, to check for possible errors in
the configuration, click Validate.

For example, validating the storage class warns you if you accidentally set Data initialization to
Macro with For signals selected. A signal cannot appear in the generated code as a macro.

Make Storage Classes Available Outside the Current Folder
To use a storage class that you create, you must make the defining package available. Either set your
current folder to the folder that contains the package or add the folder containing the package folder
to the MATLAB path (see “What Is the MATLAB Search Path?”). Adding the package to the MATLAB
path enables you to use the storage classes no matter where you set your current folder.
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Make Storage Classes Available in the Code Mappings Editor
To use package-based storage classes in the Code Mappings editor, refer to the package from an
Embedded Coder Dictionary. To configure an Embedded Coder Dictionary to refer to the package, see
“Refer to Code Generation Definitions in a Package”.

Share Storage Class Between Packages
When you create a package, you can refer to a storage class defined in another package such as the
built-in package Simulink or a different package that you created. Then, the defining package and
any referencing packages can use the storage class. When you want to make a change to the storage
class, you make the change only once, in the defining package.

To configure a package to refer to a storage class that another package defines:

1 In the Custom Storage Class Designer, select the Custom Storage Class tab.
2 Use Select Package to select the referencing package. The package must be writable.
3 In the Custom storage class definitions pane, select the existing definition below which you

want to insert the reference.
4 Click New Reference.

A new reference with a default name and properties appears below the previously selected
definition. The new reference is selected and a Reference tab appears that shows the initial
properties.

5 Use Name to specify a name for the new reference. The name must be unique in the importing
package, but can duplicate the name in the source package. The name cannot be a TLC keyword.

6 Set Refer to custom storage class in package to specify the package that contains the
storage class that you want to reference.

7 Set Custom storage class to reference to specify the storage class to be referenced.
8 Click OK or Apply. To save the changes permanently, click Save.

Control Appearance of Storage Class Drop-Down List
When you apply a storage class to a data item, you select the storage class from a drop-down list.

• To control the order of the custom storage classes in the list, in the Custom Storage Class
Designer, use the Up and Down buttons. The order of the storage classes in drop-down lists
matches the order that you specify in the Custom Storage Class Designer.

• To prevent a user of a storage class from applying the storage class to parameter data or to signal
and state data, use the For parameters and For signals check boxes. When you clear one of
these properties, for the corresponding kind of data, the storage class does not appear in the
drop-down list.

For example, if your storage class yields a macro in the generated code because you set Data
initialization to Macro, to prevent users from applying the storage class to signal data, clear For
signals.
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Protect Custom Storage Class Definitions
When you click Save in the Custom Storage Class Designer, the Designer saves memory section and
storage class definitions into the csc_registration.m file in the package folder. To determine the
location of this file, in the Custom Storage Class Designer, inspect the value of Filename.

You can prevent changes to the storage class definitions of an entire package by converting the
csc_registration.m file from a MATLAB file to a P-file. Use the pcode function.

A best practice is to keep csc_registration.m and csc_registration.p in your package folder.
That way, if you modify the storage classes by using the Designer, you can delete
csc_registration.p and later regenerate it after you finish the modifications. Because the P-
coded version of the file takes precedence, when both files exist in the package, the storage classes
are protected and you cannot modify them in the Custom Storage Class Designer.

Further Customize Generated Code by Writing TLC Code
If creating your own storage class by manipulating the properties in the Custom Storage Class
Designer does not meet your requirements, you can finely control the generated code by writing TLC
code for your storage class. Use an advanced mode of the Custom Storage Class Designer and, for
the storage class, set Type to Other. See “Finely Control Data Representation by Writing TLC Code
for a Storage Class” on page 38-24.

See Also

Related Examples
• “Create and Apply a Storage Class” on page 38-15
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Data Objects”
• “Finely Control Data Representation by Writing TLC Code for a Storage Class” on page 38-24
• “Access Structured Data Through a Pointer That External Code Defines” on page 38-10
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Finely Control Data Representation by Writing TLC Code for a
Storage Class

If creating your own storage class by using the properties in an Embedded Coder Dictionary or the
Custom Storage Class Designer does not meet your requirements for controlling data representation
in the generated code, you can write TLC code that explicitly controls the effect that a storage class
has on the code. For example, to create a storage class that yields arbitrarily nested structures, you
must write TLC code. In the Custom Storage Class Designer, these advanced storage classes have
Type set to Other. You cannot create such a storage class in an Embedded Coder Dictionary, so to
use the storage class in the Code Mappings editor, you must configure the dictionary of the model to
refer to the package that contains the storage class, as described in “Refer to Code Generation
Definitions in a Package”.

For an example, see “Generate Code That Dereferences Data from a Literal Memory Address” on
page 66-16. For general information about TLC code, see “Why Use the Target Language
Compiler?”.

Create Custom Attributes Class for Storage Class
As described in “Allow Users of Storage Class to Specify Property Value” on page 38-19, instance-
specific properties enable users of a storage class to control the effect that the storage class has on
each data item. For example, the built-in storage class ExportToFile has several instance-specific
properties such as Header file and Definition file.

When you create a storage class with Type set to Other, to add your own instance-specific properties
that are not built into the Custom Storage Class Designer, create a custom attributes class for your
package. A custom attributes class is a MATLAB class that you create as a subclass of
Simulink.CustomStorageClassAttributes. Each property that you add to your custom
attributes class appears to the user of the storage class as an instance-specific property.

To create your custom attributes class, see “Define Data Classes”.

Write TLC Code for Storage Class
To control the effect of your storage class, write TLC code that specifies the code to generate for each
data item.

1 In your package folder (for example, +myPackage), create a tlc folder.
2 Copy a TLC template such as TEMPLATE_v2.tlc from the folder matlabroot/toolbox/rtw/

targets/ecoder/csc_templates (open) into your tlc folder.
3 Write your TLC code, following the comments in the template file. The comments describe how to

specify, for example, how the generated code declares, defines, and accesses (by value or by
reference) each data item.

Create Storage Class by Using Custom Storage Class Designer
To create your storage class in your package, you open the Custom Storage Class Designer in an
advanced mode.

1 At the command prompt, enter:
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cscdesigner -advanced
2 Select your package and create a storage class.
3 For the storage class, set Type to Other. In the Other Attributes pane, specify the name of your

TLC file and the name of your custom attributes class.
4 Set the properties on the Other Attributes pane.

• Is grouped: Select this option if you intend to combine multiple data items into a single entity
in the generated code. For example, the built-in storage classes BitField and Struct are
grouped because they can aggregate multiple data items into a single structure variable.

• TLC file name: Enter the name of your TLC file. The Custom Storage Class Designer assumes
that the file exists in the package tlc folder, so specify only the name of the file, not the file
path.

• CSC attributes class name: (optional) If you created a custom attributes class, enter the full
name of the class, including the package name. For example, specify
myPackage.myCustomAttsClass. For more information, see “Create Custom Attributes
Class for Storage Class” on page 38-24.

5 On the General and Comments panes, specify values for the remaining properties.

To apply the storage class to data objects, you create the data objects from your package and
configure the objects to use your storage class. For more information on applying a custom storage
class to data objects, see “Apply Storage Class” on page 38-16. To apply the storage class in a model
by using the Code Mappings editor, you must configure the Embedded Coder Dictionary that the
model uses to refer to your package. When you refer to the package, the storage class appears in the
Embedded Coder Dictionary and becomes available in the Code Mappings editor. For more
information, see “Refer to Code Generation Definitions in a Package”.

See Also

Related Examples
• “Target Language Compiler Basics”
• “Generate Code That Dereferences Data from a Literal Memory Address” on page 66-16
• “Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Data Object Information in model.rtw File”
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Access Data Through Functions with Storage Class GetSet
To integrate the generated code with legacy code that uses specialized functions to read from and
write to data, you can use the storage class GetSet. Signals, block parameters, and states that use
GetSet appear in the generated code as calls to accessor functions. You provide the function
definitions.

You can also create your own storage class in Embedded Coder Dictionary to access data through
functions. Creating your own storage class in Embedded Coder Dictionary gives you the flexibility of
customizing function names and return types. For more information, see “Access Data Through
Functions by Using Storage Classes in Embedded Coder Dictionary” on page 38-42.

To generate code that conforms to the AUTOSAR standard by accessing data through Rte function
calls, use the AUTOSAR code perspective. See “AUTOSAR Component Configuration” (AUTOSAR
Blockset).

Access Legacy Data Using Get and Set Functions
This example shows how to generate code that interfaces with legacy code by using specialized get
and set functions to access data.

View the example legacy header file ComponentDataHdr.h. The file defines a large structure type
ComponentData.

rtwdemodbtype('ComponentDataHdr.h','/* ComponentData */','} ComponentData;',1,1)

/* ComponentData */

typedef struct {
    ScalarData scalars;
    VectorData vectors;
    StructData structs;
    MatricesData matrices;
} ComponentData;

The field scalars is a substructure that uses the structure type ScalarData. The structure type
ScalarData defines three scalar fields: inSig, scalarParam, and outSig.

rtwdemodbtype('ComponentDataHdr.h','/* ScalarData */','} ScalarData;',1,1)

/* ScalarData */

typedef struct {
    double inSig;
    double scalarParam;
    double outSig;
} ScalarData;

View the example legacy source file getsetSrc.c. The file defines and initializes a global variable
ex_getset_data that uses the structure type ComponentData. The initialization includes values for
the substructure scalars.

rtwdemodbtype('getsetSrc.c','/* Field "scalars" */','/* End of "scalars" */',1,1)
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    /* Field "scalars" */ 
    {
    3.9, 
            
    12.3, 
            
    0.0
    },
    /* End of "scalars" */

The file also defines functions that read from and write to the fields of the substructure scalars. The
functions simplify data access by dereferencing the leaf fields of the global structure variable
ex_getset_data.

rtwdemodbtype('getsetSrc.c',...
    '/* Scalar get() and set() functions */','/* End of scalar functions */',1,1)

/* Scalar get() and set() functions */

double get_inSig(void)
{
    return ex_getset_data.scalars.inSig;
}

void set_inSig(double value)
{
    ex_getset_data.scalars.inSig = value;
}

double get_scalarParam(void)
{
    return ex_getset_data.scalars.scalarParam;
}

void set_scalarParam(double value)
{
    ex_getset_data.scalars.scalarParam = value;
}

double get_outSig(void)
{
    return ex_getset_data.scalars.outSig;
}

void set_outSig(double value)
{
    ex_getset_data.scalars.outSig = value;
}

View the example legacy header file getsetHdrScalar.h. The file contains the extern prototypes
for the get and set functions defined in getsetSrc.c.

Open the example model rtwdemo_getset_scalar. The model creates the data objects inSig,
outSig, and scalarParam in the base workspace. The objects correspond to the signals and
parameter in the model.
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open_system('rtwdemo_getset_scalar')

In the base workspace, double-click the object inSig to view its properties. The object uses the
storage class GetSet. The GetFunction and SetFunction properties are set to the defaults, get_
$N and set_$N. The generated code uses the function names that you specify in GetFunction and
SetFunction to read from and write to the data. The code replaces the token $N with the name of
the data object. For example, for the data object inSig, the generated code uses calls to the legacy
functions get_inSig and set_inSig.

For the data object inSig, the HeaderFile property is set to getsetHdrScalar.h. This legacy
header file contains the get and set function prototypes. The data objects outSig and
scalarParam also use the storage class GetSet and the header file getsetHdrScalar.h.

In the model Configuration Parameters dialog box, on the Code Generation > Custom Code pane,
under Additional build information, select Source files. The Source files box identifies the
source file getsetSrc.c for inclusion during the build process. This legacy source file contains the
get and set function definitions and the definition of the global structure variable
ex_getset_data.

Generate code with the example model.

slbuild('rtwdemo_getset_scalar');

### Starting build procedure for: rtwdemo_getset_scalar
### Successful completion of build procedure for: rtwdemo_getset_scalar

Build Summary

Top model targets built:

Model                  Action                       Rebuild Reason                                    
======================================================================================================
rtwdemo_getset_scalar  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 33.294s

In the code generation report, view the file rtwdemo_getset_scalar.c. The model step function
uses the legacy get and set functions to execute the algorithm. The generated code accesses the
legacy signal and parameter data by calling the custom, handwritten get and set functions.

rtwdemodbtype(fullfile('rtwdemo_getset_scalar_ert_rtw','rtwdemo_getset_scalar.c'),...
    '/* Model step function */','}',1,1)
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/* Model step function */
void rtwdemo_getset_scalar_step(void)
{
  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In1'
   */
  set_outSig(get_scalarParam() * get_inSig());
}

You can generate code that calls your custom get and set functions as long as the functions that you
write accept and return the expected values. For scalar data, the functions must have these
characteristics:

• The get function must return a single scalar numeric value of the appropriate data type, and must
not accept any arguments (void).

• The set function must not return anything (void), and must accept a single scalar numeric value
of the appropriate data type.

Use GetSet with Vector Data
This example shows how to apply the storage class GetSet to signals and parameters that are
vectors.

View the example legacy header file ComponentDataHdr.h. The file defines a large structure type
ComponentData.

rtwdemodbtype('ComponentDataHdr.h','/* ComponentData */','} ComponentData;',1,1)

/* ComponentData */

typedef struct {
    ScalarData scalars;
    VectorData vectors;
    StructData structs;
    MatricesData matrices;
} ComponentData;

The field vectors is a substructure that uses the structure type VectorData. The structure type
VectorData defines three vector fields: inVector, vectorParam, and outVector. The vectors
each have five elements.

rtwdemodbtype('ComponentDataHdr.h','/* VectorData */','} VectorData;',1,1)

/* VectorData */
        
typedef struct {
    double inVector[5];
    double vectorParam[5];
    double outVector[5];
} VectorData;

View the example legacy source file getsetSrc.c. The file defines and initializes a global variable
ex_getset_data that uses the structure type ComponentData. The initialization includes values for
the substructure vectors.
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rtwdemodbtype('getsetSrc.c','/* Field "vectors" */','/* End of "vectors" */',1,1)

    /* Field "vectors" */
    {
        {5.7, 6.8, 1.2, 3.5, 10.1}, 
                
        {12.3, 18.7, 21.2, 28, 32.9}, 
                
        {0.0, 0.0, 0.0, 0.0, 0.0}
    },
    /* End of "vectors" */

The file also defines functions that read from and write to the fields of the substructure vectors. The
functions simplify data access by dereferencing the leaf fields of the global structure variable
ex_getset_data. To access the vector data, the functions accept an integer index argument. The
get function returns the vector value at the input index. The set function assigns the input value to
the input index.

rtwdemodbtype('getsetSrc.c',...
    '/* Vector get() and set() functions */','/* End of vector functions */',1,1)

/* Vector get() and set() functions */

double get_inVector(int index)
{
    return ex_getset_data.vectors.inVector[index];
}

void set_inVector(int index, double value)
{
    ex_getset_data.vectors.inVector[index] = value;
}

double get_vectorParam(int index)
{
    return ex_getset_data.vectors.vectorParam[index];
}

void set_vectorParam(int index, double value)
{
    ex_getset_data.vectors.vectorParam[index] = value;
}

double get_outVector(int index)
{
    return ex_getset_data.vectors.outVector[index];
}

void set_outVector(int index, double value)
{
       ex_getset_data.vectors.outVector[index] = value;
}

View the example legacy header file getsetHdrVector.h. The file contains the extern prototypes
for the get and set functions defined in getsetSrc.c.
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Open the example model rtwdemo_getset_vector. The model creates the data objects inVector,
outVector, and vectorParam in the base workspace. The objects correspond to the signals and
parameter in the model.

open_system('rtwdemo_getset_vector')

In the base workspace, double-click the object inVector to view its properties. The object uses the
storage class GetSet. The property HeaderFile is specified as getsetHdrVector.h. This legacy
header file contains the get and set function prototypes.

In the Configuration Parameters dialog box, on the Code Generation > Custom Code pane, the
example legacy source file getsetSrc.c is identified for inclusion during the build process. This
legacy source file contains the get and set function definitions and the definition of the global
structure variable ex_getset_data.

Generate code with the example model.

slbuild('rtwdemo_getset_vector');

### Starting build procedure for: rtwdemo_getset_vector
### Successful completion of build procedure for: rtwdemo_getset_vector

Build Summary

Top model targets built:

Model                  Action                       Rebuild Reason                                    
======================================================================================================
rtwdemo_getset_vector  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.484s

In the code generation report, view the file rtwdemo_getset_vector.c. The model step function
uses the legacy get and set functions to execute the algorithm.

rtwdemodbtype(fullfile('rtwdemo_getset_vector_ert_rtw','rtwdemo_getset_vector.c'),...
    '/* Model step function */','}',1,1)

/* Model step function */
void rtwdemo_getset_vector_step(void)
{
  int32_T i;
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  for (i = 0; i < 5; i++) {
    /* Gain: '<Root>/Gain' incorporates:
     *  Inport: '<Root>/In1'
     */
    set_outVector(i, get_vectorParam(i) * get_inVector(i));
  }

When you use the storage class GetSet with vector data, the get and set functions that you provide
must accept an index input. The get function must return a single element of the vector. The set
function must write to a single element of the vector.

Use GetSet with Structured Data
This example shows how to apply the storage class GetSet to nonvirtual bus signals and structure
parameters in a model.

View the example legacy header file ComponentDataHdr.h. The file defines a large structure type
ComponentData.

rtwdemodbtype('ComponentDataHdr.h',...
    '/* ComponentData */','} ComponentData;',1,1)

/* ComponentData */

typedef struct {
    ScalarData scalars;
    VectorData vectors;
    StructData structs;
    MatricesData matrices;
} ComponentData;

The field structs is a substructure that uses the structure type StructData. The structure type
StructData defines three fields: inStruct, structParam, and outStruct.

rtwdemodbtype('ComponentDataHdr.h','/* StructData */','} StructData;',1,1)

/* StructData */
        
typedef struct {
    SigBus inStruct;
    ParamBus structParam;
    SigBus outStruct;
} StructData;

The fields inStruct, structParam, and outStruct are also substructures that use the structure
types SigBus and ParamBus. Each of these two structure types define three scalar fields.

rtwdemodbtype('ComponentDataHdr.h','/* SigBus */','} ParamBus',1,1)

/* SigBus */

typedef struct {
    double cmd;
    double sensor1;
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    double sensor2;
} SigBus;

/* ParamBus */

typedef struct {
    double offset;
    double gain1;
    double gain2;
} ParamBus;

View the example legacy source file getsetSrc.c. The file defines and initializes a global variable
ex_getset_data that uses the structure type ComponentData. The initialization includes values for
the substructure structs.

rtwdemodbtype('getsetSrc.c',...
    '/* Field "structs" */','/* End of "structs" */',1,1)

    /* Field "structs" */
    { 
        {1.3, 5.7, 9.2},
                
        {12.3, 9.6, 1.76},
                
        {0.0, 0.0, 0.0}
    },
    /* End of "structs" */

The file also defines functions that read from and write to the fields of the substructure structs. The
functions simplify data access by dereferencing the fields of the global structure variable
ex_getset_data. The functions access the data in the fields inStruct, structParam, and
outStruct by accepting and returning complete structures of the types SigBus and ParamBus.

rtwdemodbtype('getsetSrc.c',...
    '/* Structure get() and set() functions */',...
    '/* End of structure functions */',1,1)

/* Structure get() and set() functions */

SigBus get_inStruct(void)
{
    return ex_getset_data.structs.inStruct;
}

void set_inStruct(SigBus value)
{
    ex_getset_data.structs.inStruct = value;
}

ParamBus get_structParam(void)
{
    return ex_getset_data.structs.structParam;
}

void set_structParam(ParamBus value)
{
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    ex_getset_data.structs.structParam = value;
}

SigBus get_outStruct(void)
{
    return ex_getset_data.structs.outStruct;
}

void set_outStruct(SigBus value)
{
    ex_getset_data.structs.outStruct = value;
}

View the example legacy header file getsetHdrStruct.h. The file contains the extern prototypes
for the get and set functions defined in getsetSrc.c.

Open the example model rtwdemo_getset_struct. The model creates the data objects inStruct,
structParam, and outStruct in the base workspace. The objects correspond to the signals and
parameter in the model.

open_system('rtwdemo_getset_struct')

In the base workspace, double-click the object inStruct to view its properties. The object uses the
storage class GetSet. The property HeaderFile is specified as getsetHdrStruct.h. This legacy
header file contains the get and set function prototypes.

The model also creates the bus objects ParamBus and SigBus in the base workspace. The signals
and parameter in the model use the bus types that these objects define. The property DataScope of
each bus object is set to Imported. The property HeaderFile is set to ComponentDataHdr.h. The
generated code imports these structure types from the legacy header file ComponentDataHdr.h.

In the model Configuration Parameters dialog box, on the Code Generation > Custom Code pane,
the example legacy source file getsetSrc.c is identified for inclusion during the build process. This
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legacy source file contains the get and set function definitions and the definition of the global
structure variable ex_getset_data.

Generate code with the example model.

slbuild('rtwdemo_getset_struct');

### Starting build procedure for: rtwdemo_getset_struct
### Successful completion of build procedure for: rtwdemo_getset_struct

Build Summary

Top model targets built:

Model                  Action                       Rebuild Reason                                    
======================================================================================================
rtwdemo_getset_struct  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.086s

In the code generation report, view the file rtwdemo_getset_struct.c. The model step function
uses the legacy get and set functions to execute the algorithm.

rtwdemodbtype(fullfile('rtwdemo_getset_struct_ert_rtw',...
    'rtwdemo_getset_struct.c'),...
    '/* Model step function */','}',1,1)

/* Model step function */
void rtwdemo_getset_struct_step(void)
{
  /* Bias: '<Root>/Bias' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtDW.BusCreator.cmd = (get_inStruct()).cmd + (get_structParam()).offset;

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtDW.BusCreator.sensor1 = (get_structParam()).gain1 * (get_inStruct()).sensor1;

  /* Gain: '<Root>/Gain1' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtDW.BusCreator.sensor2 = (get_structParam()).gain2 * (get_inStruct()).sensor2;

  /* SignalConversion: '<Root>/Signal Conversion' */
  set_outStruct(rtDW.BusCreator);
}

When you use the storage class GetSet with structured data, the get and set functions that you
provide must return and accept complete structures. The generated code dereferences individual
fields of the structure that the get function returns.

The output signal of the Bus Creator block is a test point. This signal is the input for a Signal
Conversion block. The test point and the Signal Conversion block exist so that the generated code

 Access Data Through Functions with Storage Class GetSet

38-35



defines a variable for the output of the Bus Creator block. To provide a complete structure argument
for the function set_outStruct, you must configure the model to create this variable.

Use GetSet with Matrix Data
This example shows how to apply the storage class GetSet to signals and parameters that are
matrices.

View the example legacy header file ComponentDataHdr.h. The file defines a large structure type
ComponentData.

rtwdemodbtype('ComponentDataHdr.h',...
    '/* ComponentData */','} ComponentData;',1,1)

/* ComponentData */

typedef struct {
    ScalarData scalars;
    VectorData vectors;
    StructData structs;
    MatricesData matrices;
} ComponentData;

The field matrices is a substructure that uses the structure type MatricesData. The structure type
MatricesData defines three fields: matrixInput, matrixParam, and matrixOutput. The fields
store matrix data as serial arrays. In this case, the input and parameter fields each have 15 elements.
The output field has nine elements.

rtwdemodbtype('ComponentDataHdr.h'...
    ,'/* MatricesData */','} MatricesData;',1,1)

/* MatricesData */

typedef struct {
    double matrixInput[15];
    double matrixParam[15];
    double matrixOutput[9];
} MatricesData;

View the example legacy source file getsetSrc.c. The file defines and initializes a global variable
ex_getset_data that uses the structure type ComponentData. The initialization includes values for
the substructure matrices.

rtwdemodbtype('getsetSrc.c',...
    '/* Field "matrices" */','/* End of "matrices" */',1,1)

    /* Field "matrices" */
    {
        {12.0, 13.9, 7.4,
         0.5, 11.8, 6.4,
         4.7, 5.3, 13.0,
         0.7, 16.1, 13.5,
         1.6, 0.5, 3.1},
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        {8.3, 12.0, 11.5, 2.0, 5.7,
         7.5, 12.8, 11.1, 8.4, 9.9,
         10.9, 4.6, 2.7, 16.3, 3.8},
                
        {0.0, 0.0, 0.0,
         0.0, 0.0, 0.0,
         0.0, 0.0, 0.0}
    }
    /* End of "matrices" */

The input matrix has five rows and three columns. The matrix parameter has three rows and five
columns. The matrix output has three rows and three columns. The file defines macros that indicate
these dimensions.

rtwdemodbtype('getsetSrc.c',...
    '/* Matrix dimensions */','/* End of matrix dimensions */',1,1)

/* Matrix dimensions */

#define MATRIXINPUT_NROWS 5
#define MATRIXINPUT_NCOLS 3

#define MATRIXPARAM_NROWS 3
#define MATRIXPARAM_NCOLS 5

#define MATRIXOUTPUT_NROWS MATRIXPARAM_NROWS
#define MATRIXOUTPUT_NCOLS MATRIXINPUT_NCOLS

The file also defines functions that read from and write to the fields of the substructure matrices.

rtwdemodbtype('getsetSrc.c',...
    '/* Matrix get() and set() functions */','/* End of matrix functions */',1,1)

/* Matrix get() and set() functions */

double get_matrixInput(int colIndex)
{
    int rowIndexGetInput = MATRIXINPUT_NCOLS * (colIndex % MATRIXINPUT_NROWS) + colIndex/MATRIXINPUT_NROWS;
    return ex_getset_data.matrices.matrixInput[rowIndexGetInput];
}

void set_matrixInput(int colIndex, double value)
{
    int rowIndexSetInput = MATRIXINPUT_NCOLS * (colIndex % MATRIXINPUT_NROWS) + colIndex/MATRIXINPUT_NROWS;
    ex_getset_data.matrices.matrixInput[rowIndexSetInput] = value;
}

double get_matrixParam(int colIndex)
{
    int rowIndexGetParam = MATRIXPARAM_NCOLS * (colIndex % MATRIXPARAM_NROWS) + colIndex/MATRIXPARAM_NROWS;
    return ex_getset_data.matrices.matrixParam[rowIndexGetParam];
}

void set_matrixParam(int colIndex, double value)
{
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    int rowIndexSetParam = MATRIXPARAM_NCOLS * (colIndex % MATRIXPARAM_NROWS) + colIndex/MATRIXPARAM_NROWS;
    ex_getset_data.matrices.matrixParam[rowIndexSetParam] = value;
}

double get_matrixOutput(int colIndex)
{
    int rowIndexGetOut = MATRIXOUTPUT_NCOLS * (colIndex % MATRIXOUTPUT_NROWS) + colIndex/MATRIXOUTPUT_NROWS;
    return ex_getset_data.matrices.matrixOutput[rowIndexGetOut];  
}

void set_matrixOutput(int colIndex, double value)
{
    int rowIndexSetOut = MATRIXOUTPUT_NCOLS * (colIndex % MATRIXOUTPUT_NROWS) + colIndex/MATRIXOUTPUT_NROWS;
    ex_getset_data.matrices.matrixOutput[rowIndexSetOut] = value;
}

The code that you generate from a model represents matrices as serial arrays. Therefore, each of the
get and set functions accept a single scalar index argument.

The generated code uses column-major format to store and to access matrix data. However, many C
applications use row-major indexing. To integrate the generated code with the example legacy code,
which stores the matrices matrixInput and matrixParam using row-major format, the custom get
functions use the column-major index input to calculate an equivalent row-major index. The
generated code algorithm, which interprets matrix data using column-major format by default,
performs the correct matrix math because the get functions effectively convert the legacy matrices
to column-major format. The set function for the output, matrixOutput, also calculates a row-major
index so the code writes the algorithm output to matrixOutput using row-major format.
Alternatively, to integrate the column-major generated code with your row-major legacy code, you can
manually convert the legacy code to column-major format by transposing your matrix data and
algorithms.

View the example legacy header file getsetHdrMatrix.h. The file contains the extern prototypes
for the get and set functions defined in getsetSrc.c.

Open the example model rtwdemo_getset_matrix. The model creates the data objects
matrixInput, matrixParam, and matrixOutput in the base workspace. The objects correspond to
the signals and parameter in the model.

load_system('rtwdemo_getset_matrix')
set_param('rtwdemo_getset_matrix','SimulationCommand','Update')
open_system('rtwdemo_getset_matrix')
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In the base workspace, double-click the object matrixInput to view its properties. The object uses
the storage class GetSet. The property HeaderFile is specified as getsetHdrMatrix.h. This
legacy header file contains the get and set function prototypes.

In the Configuration Parameters dialog box, on the Code Generation > Custom Code pane, the
example legacy source file getsetSrc.c is identified for inclusion during the build process. This
legacy source file contains the get and set function definitions and the definition of the global
structure variable ex_getset_data.

Generate code with the example model.

slbuild('rtwdemo_getset_matrix');

### Starting build procedure for: rtwdemo_getset_matrix
### Successful completion of build procedure for: rtwdemo_getset_matrix

Build Summary

Top model targets built:

Model                  Action                       Rebuild Reason                                    
======================================================================================================
rtwdemo_getset_matrix  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.345s

In the code generation report, view the file rtwdemo_getset_matrix.c. The model step function
uses the legacy get and set functions to execute the algorithm.

rtwdemodbtype(fullfile('rtwdemo_getset_matrix_ert_rtw',...
    'rtwdemo_getset_matrix.c'),'/* Model step function */','}',1,1)

/* Model step function */
void rtwdemo_getset_matrix_step(void)
{
  int32_T i;
  int32_T i_0;
  int32_T i_1;
  int32_T matrixOutput_tmp;
  for (i_0 = 0; i_0 < 3; i_0++) {
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    for (i = 0; i < 3; i++) {
      /* Product: '<Root>/Product' incorporates:
       *  Constant: '<Root>/Constant'
       *  Inport: '<Root>/In1'
       */
      matrixOutput_tmp = i + 3 * i_0;
      set_matrixOutput(matrixOutput_tmp, 0.0);
      for (i_1 = 0; i_1 < 5; i_1++) {
        set_matrixOutput(matrixOutput_tmp, get_matrixParam(3 * i_1 + i) *
                         get_matrixInput(5 * i_0 + i_1) + get_matrixOutput
                         (matrixOutput_tmp));
      }

Specify Header File or Function Naming Scheme for Data Items
By default, you specify a header file name, get function name, and set function name for each data
item, such as a signal or parameter, that uses the storage class GetSet.

To configure a single header file, get function naming scheme, or set function naming scheme to use
for every data item, you can use the Custom Storage Class Designer to create your own copy of
GetSet. You can specify the header file or function names in a single location.

Follow these steps to create your own storage class by creating your own data class package,
creating a copy of GetSet, and applying the new storage class to data items in your model.

1 Create your own data class package, myPackage, by copying the example package folder
+SimulinkDemos and renaming the copied folder as +myPackage. Modify the Parameter and
Signal class definitions so that they use the storage class definitions from myPackage. For an
example, see “Create Data Class Package” on page 38-15.

2 Set your current folder to the folder that contains the package folder. Alternatively, add the folder
containing the package folder to your MATLAB path.

3 Open the Custom Storage Class Designer.

cscdesigner('myPackage')
4 Select the storage class GetSet. Click Copy to create a copy called GetSet_1.
5 Select the new storage class GetSet_1. In the General tab, set Name to myGetSet.
6 Set the drop-down list Header file to Specify. In the new text box, set Header file to

myFcnHdr.h. Click Apply.
7 On the Access Function Attributes tab, set the drop-down lists Get function and Set

function to Specify.
8 In the new boxes, set Get function to myGetFcn_$N and Set function to mySetFcn_$N. Click

OK. Click Yes in response to the message about saving changes.

When you generate code, the token $N expands into the name of the data item that uses this
storage class.

9 Apply the storage class myGetSet from your package to a data item. For example, create a
myPackage.Parameter object in the base workspace.

myParam = myPackage.Parameter(15.23);
myParam.CoderInfo.StorageClass = 'Custom';
myParam.CoderInfo.CustomStorageClass = 'myGetSet';
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10 Use the object to set a parameter value in your model. When you generate code, the code
algorithm accesses the parameter through the functions that you specified. The code uses an
#include directive to include the header file that you specified.

Access Scalar and Array Data Through Macro Instead of Function Call
If you implement the get mechanism for scalar or array data as a macro instead of a function, you
can generate code that omits parentheses when reading that data.

• For scalar data, your macro must yield the scalar value.
• For array data, your macro must yield the starting memory address.

Create your own AccessFunction storage class by using the Custom Storage Class Designer, as
described in “Specify Header File or Function Naming Scheme for Data Items” on page 38-40. In the
Designer, on the Access Function Attributes tab, select Get data through macro (omit
parentheses).

GetSet Storage Class Restrictions
• GetSet does not support complex signals.
• Multiple data in the same model cannot use the same GetFunction or SetFunction.
• Some blocks do not directly support GetSet.
• Custom S-functions do not directly support GetSet.

To use GetSet with an unsupported block or a custom S-function:

1 Insert a Signal Conversion block at the output of the block or function.
2 In the Signal Conversion block dialog box, select Exclude this block from 'Block reduction'

optimization.
3 Assign the storage class GetSet to the output of the Signal Conversion block.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Create and Apply a Storage Class” on page 38-15
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Finely Control Data Representation by Writing TLC Code for a Storage Class” on page 38-24
• “Generate Code That Dereferences Data from a Literal Memory Address” on page 66-16
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Access Data Through Functions by Using Storage Classes in
Embedded Coder Dictionary

To replace the direct access to data in the generated code with your own or legacy functions that
read and write data in a customized way, you can enable function access on your storage classes. You
create these storage classes in the Embedded Coder Dictionary. Root-level inports, root-level
outports, and model parameters that use your storage class appear in the generated code as calls to
specified functions. You provide the function declarations and definitions in separate header and
source files pointed to by the storage class.

Access Legacy Data by Value
You can define and apply a storage class to root-level inports, root-level outports, and model
parameters so they can be accessed by customizable get and set functions. Such customization can
be useful, for example, to abstract layers of software, gain access to data from an external file or to
control access to critical sections of code.

This example shows how to set up a storage class in the Embedded Coder Dictionary and map the
storage class to root-level inports/outports and model parameters in the Code Mappings editor.

1 Open example model rtwdemo_roll. In the MATLAB command window, run this command:

addpath(fullfile(docroot,'toolbox','ecoder','examples'))

Running the preceding command gives you these supporting files required for the example that
define the get and set functions:

• rtwdemo_roll_Value.h
• rtwdemo_roll_Value.c
• rtwdemo_roll_Pointer.h
• rtwdemo_roll_Pointer.c

Save these files to your local path.
2 In the Apps gallery, under Code Generation, click Embedded Coder.
3 To open the Embedded Coder Dictionary, on the C Code tab, click Code Interface > Embedded

Coder Dictionary.
4 The rtwdemo_roll model has two storage classes: SignalStruct and ParamStruct. They are

already created by using the Add button. This example uses these storage classes. You can
perform the following steps for a storage class that you create as well.

5 For the SignalStruct storage class, in the Property Inspector pane, update these property
values:

• Data Access to Function
• Header File to $R_Value.h

Make sure that Access Mode is set to Value. Data Scope is set to Imported by default and
cannot be changed.
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For the ParamStruct storage class, in the Property Inspector pane, update these property
values:

• Data Access to Function
• Header File to $R_Value.h

These properties are already set:

• Access Mode to Value
• Data Initialization to Static

Storage classes used for parameters can have Data Initialization set to Auto,Static, or None.
6 Open the Configuration Parameters dialog box. In the toolstrip, on the C Code tab, click

Settings. Select Code Generation > Custom Code > Additional build information >
Source files and specify:

rtwdemo_roll_Value.c
7 In the Embedded Coder app, open the Code Mappings editor. On the Data Defaults tab, map

these model element categories:

• Inports to SignalStruct
• Outports to SignalStruct
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• Model parameters to ParamStruct

8 Build the model and generate code.

In the generated code, view the file rtwdemo_roll.c. The model step function uses the specified
get and set functions to execute the algorithm. The generated code accesses the legacy data by
calling the custom, handwritten get and set functions. For example, here is the code snippet for the
HDG_Ref inport:

if (get_HDG_Mode()) {
    /* Outputs for Atomic SubSystem: '<Root>/HeadingMode' */
    rtb_Sum1 = (get_HDG_Ref() - get_Psi()) * 0.015F * get_TAS();

    /* End of Outputs for SubSystem: '<Root>/HeadingMode' */
  } else {
    /* Outputs for Atomic SubSystem: '<Root>/RollAngleReference' */
    if ((real32_T)fabs(get_Turn_Knob()) >= 3.0F) {
      rtb_Sum1 = get_Turn_Knob();
    }

You can generate code that calls your custom get and set functions if the functions that you write
accept and return the expected values.

Access Legacy Data by Pointer
To access data using a pointer, follow all the preceding steps but make these changes:

• In the Embedded Coder Dictionary, for storage classes SignalStruct and ParamStruct,
specify:

• Access Mode to Pointer
• Header File to $R_Pointer.h

• Select Configuration Parameters > Code Generation > Custom Code > Additional build
information > Source files and replace rtwdemo_roll_Value.c with:

rtwdemo_roll_Pointer.c
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With the pointer access, a get function now returns a pointer whose value must be dereferenced with
the * before use. For example, the generated code for the HDG_Ref inport now looks like this code:

if (*get_HDG_Mode()) {
    /* Outputs for Atomic SubSystem: '<Root>/HeadingMode' */
    rtb_Sum1 = (*get_HDG_Ref() - *get_Psi()) * 0.015F * *get_TAS();

    /* End of Outputs for SubSystem: '<Root>/HeadingMode' */
  } else {
    /* Outputs for Atomic SubSystem: '<Root>/RollAngleReference' */
    if ((real32_T)fabs(tmp_1) >= 3.0F) {
      rtb_Sum1 = tmp_1;
    }

Creating your own storage class in Embedded Coder Dictionary gives you the flexibility of
customizing function names and return types. You can also use the storage class GetSet to access
data through get and set functions. For more information, see “Access Data Through Functions with
Storage Class GetSet” on page 38-26.

See Also
Embedded Coder Dictionary

Related Examples
• “Access Data Through Functions with Storage Class GetSet” on page 38-26
• “Access Structured Data Through a Pointer That External Code Defines” on page 38-10
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Integrate External Application Code with Code Generated from
PID Controller

This example shows how to generate C code from a control algorithm model and integrate that code
with existing, external application code. In the complete application, which consists of three modules,
the algorithm module must exchange data with other modules through global variables. In the
example, you configure the generated code to interact with existing external variables, resemble the
external code in appearance and organization, and conform to specific coding requirements.

Inspect External Code

Set your current folder to a writable location.

Copy the script prepare_ext_code to your current folder and run the script. The script copies
external code files into several folders.

try
copyfile(fullfile(matlabroot,'examples','ecoder','main','prepare_ext_code.m'),...
    'prepare_ext_code.m','f');
catch
end
run('prepare_ext_code.m');

In your current folder, open ext_code_main.c. This application code represents an embedded
system with a trivial scheduling algorithm (a while loop) and three modules whose algorithms run in
every execution cycle: ex_ext_inputs_proc, ex_ext_ctrl_alg, and ex_ext_outputs_proc.

type('ext_code_main.c')

In the shared folder, inspect ex_ext_projTypes.h. The file defines two custom data types
(typedef) that the data in the modules use.

type(fullfile('shared','ex_ext_projTypes.h'))

In the io_drivers folder, inspect ex_sensor_accessors.c. This file defines functions,
get_fromSensor_flow and get_fromSensor_temp, that return raw data recorded by a flow
sensor and a temperature sensor. For this example, the functions return trivial sinusoidal stimuli for
the control algorithm.

type(fullfile('io_drivers','ex_sensor_accessors.c'))

In the ex_ext_inputs_proc folder, inspect ex_ext_inputs_proc.c. The ex_ext_inputs_proc
module reads the sensor data (by calling the accessor functions), filters the data, and stores it in two
global variables, PROC_INPUT_FLOW and PROC_INPUT_TEMP. These global variables are defined in
the file ex_ext_proc_inputs.c and declared in ex_ext_proc_inputs.h.

type(fullfile('ex_ext_inputs_proc','ex_ext_inputs_proc.c'))

The filter algorithm in this module and the algorithms in the other two modules require state data,
which must persist between execution cycles of the application. Each module stores relevant state
data as global variables. For example, in the ex_ext_inputs_proc module,
ex_ext_inputs_proc.c defines these variables:

• flowFilterIn_state_data
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• tempFilterIn_state_data
• flowFilterIn_tmp_data
• tempFilterIn_tmp_data

The empty ex_ext_ctrl_alg folder is a placeholder for the generated code. The
ex_ext_ctrl_alg module must perform PID control on the filtered flow and temperature
measurements. Later, you examine the requirements for this code, which are based on the code in the
other modules.

In the ex_ext_outputs_proc folder, inspect ex_ext_outputs_proc.c. This module reads the PID
output signals from global variables named CONTR_SIG_FLOW and CONTR_SIG_TEMP. The
ex_ext_ctrl_alg module (the generated code) must define these variables. The
ex_ext_outputs_proc module then filters these signals and passes the filtered values to functions
that represent device drivers for actuators (for example, a valve and a heater filament).

type(fullfile('ex_ext_outputs_proc','ex_ext_outputs_proc.c'))

The actuator functions are defined in the io_drivers folder in the file
ex_actuator_accessors.c.

The figure shows the intended flow of data through the system. The figure also shows the code files
that define and declare the data (global variables) that cross the module boundaries.
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Inspect Simulink Model and Determine Requirements for Generated Code

Open the example model ex_ext_ctrl_alg.

open_system('ex_ext_ctrl_alg')

The blocks in the model implement the required PID control algorithm. The model uses default code
generation settings for an ERT-based system target file (ert.tlc).

To complete the application by performing the function of the ex_ext_ctrl_alg module, the code
generated from this model must:

• Use the custom data types dataPath_flow_T and dataPath_temp_T from the external file
ex_ext_projTypes.h.

• Read filtered sensor data from the global variables PROC_INPUT_FLOW and PROC_INPUT_TEMP.
The generated code must not define these variables because the module ex_ext_inputs_proc
defines them, declaring them in ex_ext_proc_inputs.h.

• Write PID control signals to global variables named CONTR_SIG_FLOW and CONTR_SIG_TEMP. The
generated code must define these variables and declare them in a file named
ex_ext_ctrl_sigs.h. Then, the ex_ext_outputs_proc module can read the raw control
signals from them.

• Conform to variable naming standards that govern the external application. For example, the
generated code must store state data in global variables whose names end in _data. In addition,
for this example, the names of local function variables must end in _local.

• Conform to standards that govern the organization of the code in each of the external files. For
example, each file contains sections, delimited by comments, that aggregate similar code
constructs such as type definitions, variable declarations, and function definitions.

So that you and others can interact with the control algorithm during execution, for this example, you
also configure the generated code to define and declare const global variables named
PARAM_setpoint_flow and PARAM_setpoint_temp, which represent the PID controller setpoints.
The definitions must appear in a file named ex_ext_ctrl_params.c and the declarations must
appear in a file named ex_ext_ctrl_params.h.

Configure Model to Use Custom Data Types

Set your current folder to the shared folder.

Use the function Simulink.importExternalCTypes to generate Simulink.AliasType objects
that represent the custom data types dataPath_flow_T and dataPath_temp_T.

cd('shared')
Simulink.importExternalCTypes('ex_ext_projTypes.h');

The objects appear in the base workspace.

In the ex_ext_ctrl_alg model, on the Modeling tab, click Model Data Editor.

In the Model Data Editor, for the Inport block that represents PROC_INPUT_FLOW, set Data Type to
dataPath_flow_T.

For the Inport block that represents PROC_INPUT_TEMP, set Data Type to dataPath_temp_T.

Select the Signals tab.
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In the model, select the output signal of each Constant block. In the Model Data Editor, set Data
Type to Inherit: Inherit via back propagation. With this setting, each Constant block
inherits its output data type from the block immediately downstream, in this case, a Sum block.

Alternatively, to configure the data types, at the command prompt, use these commands.

set_param('ex_ext_ctrl_alg/In1','OutDataTypeStr','dataPath_flow_T')
set_param('ex_ext_ctrl_alg/In2','OutDataTypeStr','dataPath_temp_T')
set_param('ex_ext_ctrl_alg/Flow Setpt','OutDataTypeStr',...
    'Inherit: Inherit via back propagation')
set_param('ex_ext_ctrl_alg/Temp Setpt','OutDataTypeStr',...
    'Inherit: Inherit via back propagation')

Update the block diagram. The diagram shows that, due to data type inheritance and propagation,
signals in the model use a custom data type.

Configure Interface Data

Configure the model to generate code that accesses and defines the correct global variables such as
PROC_INPUT_FLOW and CONTR_SIG_TEMP.

In the Model Data Editor, select the Inports/Outports tab and set the Change view drop-down list
to Code.

Select the rows that correspond to the two Inport blocks.

For either row, set Storage Class to ImportFromFile and Header File to
ex_ext_proc_inputs.h. With the storage class ImportFromFile, each Inport block appears in
the generated code as a global variable. However, the generated code does not define the variable,
instead including (#include) the variable declaration from ex_ext_proc_inputs.h.

For the rows that correspond to the Outport blocks, set:

• Storage Class to ExportToFile
• Header file to ex_ext_ctrl_sigs.h
• Definition File to ex_ext_ctrl_sigs.c

With ExportToFile, the generated code defines the global variable.

Alternatively, to configure the signals, at the command prompt, use these commands.

temp = Simulink.Signal;
temp.CoderInfo.StorageClass = 'Custom';
temp.CoderInfo.CustomStorageClass = 'ImportFromFile';
temp.CoderInfo.CustomAttributes.HeaderFile = 'ex_ext_proc_inputs.h';

portHandles = get_param('ex_ext_ctrl_alg/In1','portHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle,'SignalObject',copy(temp))

portHandles = get_param('ex_ext_ctrl_alg/In2','portHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle,'SignalObject',copy(temp))

temp.CoderInfo.CustomStorageClass = 'ExportToFile';
temp.CoderInfo.CustomAttributes.HeaderFile = 'ex_ext_ctrl_sigs.h';
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temp.CoderInfo.CustomAttributes.DefinitionFile = 'ex_ext_ctrl_sigs.c';

set_param('ex_ext_ctrl_alg/Out1','SignalObject',copy(temp))
set_param('ex_ext_ctrl_alg/Out2','SignalObject',copy(temp))

To apply a storage class to a block parameter, such as the Constant value parameter of a Constant
block, you must create a parameter object such as Simulink.Parameter. You can use the Model
Data Editor to create parameter objects.

Select the Parameters tab and set Change view to Design.

In the model, select the Constant block labeled Flow Setpt.

In the Model Data Editor, set Value to PARAM_setpoint_flow.

Next to PARAM_setpoint_flow, click the action button (with three vertical dots) and select Create.

In the Create New Data dialog box, set Value to Simulink.Parameter(3).

Set Location to Model Workspace and click Create.

In the PARAM_setpoint_flow property dialog box, set Storage class to Const.

Set HeaderFile to ex_ext_ctrl_params.h and DefinitionFile to ex_ext_ctrl_params.c.

For the other Constant block, use the Model Data Editor to create a Simulink.Parameter object
named PARAM_setpoint_temp with value 2.

Alternatively, to configure the blocks, at the command prompt, use these commands.

PARAM_setpoint_flow = Simulink.Parameter(3);
PARAM_setpoint_flow.CoderInfo.StorageClass = 'Custom';
PARAM_setpoint_flow.CoderInfo.CustomStorageClass = 'Const';
PARAM_setpoint_flow.CoderInfo.CustomAttributes.HeaderFile = 'ex_ext_ctrl_params.h';
PARAM_setpoint_flow.CoderInfo.CustomAttributes.DefinitionFile = 'ex_ext_ctrl_params.c';

PARAM_setpoint_temp = copy(PARAM_setpoint_flow);
PARAM_setpoint_temp.Value = 2;

mdlwks = get_param('ex_ext_ctrl_alg','ModelWorkspace');
assignin(mdlwks,'PARAM_setpoint_flow',copy(PARAM_setpoint_flow))
assignin(mdlwks,'PARAM_setpoint_temp',copy(PARAM_setpoint_temp))

set_param('ex_ext_ctrl_alg/Flow Setpt','Value','PARAM_setpoint_flow')
set_param('ex_ext_ctrl_alg/Temp Setpt','Value','PARAM_setpoint_temp')

clear temp PARAM_setpoint_flow PARAM_setpoint_temp mdlwks portHandles outportHandle

Configure Internal Data

In the external code, internal data that does not participate in the module interfaces, such as state
data and local variables in functions, conform to naming schemes. In the model, configure internal
data that appears in the generated code to mimic these naming schemes.

In the model Configuration Parameters dialog box, inspect the Code Generation > Identifiers pane.
When you specify values for the naming schemes under Identifier format control:
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• $R represents the name of the model, ex_ext_ctrl_alg.
• $N represents the name of each model element to which the scheme applies, such as a signal,

block state, or standard data structure.
• $M represents name-mangling text that the code generator inserts, if necessary, to avoid name

clashes. For most naming rules, this token is required.

Set Global variables to $R$N_data$M. This setting controls the names of global variables, such as
those that represent state data. The naming scheme $R$N_data_$M most closely approximates the
scheme that the state variables in the external code use.

Set Local temporary variables and Local block output variables to $N_local$M.

Alternatively, to set the configuration parameters, at the command prompt, use these commands.

set_param('ex_ext_ctrl_alg','CustomSymbolStrGlobalVar','$R$N_data$M')
set_param('ex_ext_ctrl_alg','CustomSymbolStrTmpVar','$N_local$M')
set_param('ex_ext_ctrl_alg','CustomSymbolStrBlkIO','$N_local$M')

Configure the state data in the model to appear in the generated code as separate global variables
instead of fields of the standard DWork structure. Enable the Code perspective. In the Apps gallery,
click Embedded Coder.

Underneath the block diagram, under Code Mappings > Data Defaults, for the Internal data row,
in the Storage Class column select ExportedGlobal.

Alternatively, to configure this default storage class, use these commands at the command prompt:

coder.mapping.create('ex_ext_ctrl_alg');
coder.mapping.defaults.set('ex_ext_ctrl_alg','InternalData',...
    'StorageClass','ExportedGlobal');

Configure Organization of Code in Each Generated File

Set your current folder to the ex_ext_ctrl_alg folder.

cd(fullfile('..','ex_ext_ctrl_alg'))

At the command prompt, navigate to the folder that contains the built-in code generation template
ert_code_template.cgt. By default, when you generate code with the system target file ert.tlc,
this template governs the organization and, in part, the appearance of the code in each generated
file.

currentFolder = pwd;
cd(fullfile(matlabroot,'toolbox','rtw','targets','ecoder'))

Copy the ert_code_template.cgt file to your clipboard.

Return to the ex_ext_ctrl_alg folder. To avoid overwriting your clipboard, instead of using the
command prompt to navigate to the folder, you can use the Back button in MATLAB.

cd(currentFolder)
clear currentFolder

Paste the file into the ex_ext_ctrl_alg folder. Rename the file as ex_my_code_template.cgt.

Open the file and replace the contents with this code.
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type(fullfile(matlabroot,'examples','ecoder','data','ex_my_code_template.cgt'))

This new template conforms more closely to the organization of the external files. For example, the
template organizes similar code constructs into named sections (delimited by comments) and, at the
top of the template, specifies only minimal information about each generated file.

In the model, select Configuration Parameters > Code Generation > Templates.

Under Code templates and Data templates, set the four configuration parameters to
ex_my_code_template.cgt.

Alternatively, to copy the file and set the parameters, at the command prompt, use these commands.

copyfile(fullfile(matlabroot,'examples','ecoder','data','ex_my_code_template.cgt'),...
    'ex_my_code_template.cgt','f')
set_param('ex_ext_ctrl_alg','ERTSrcFileBannerTemplate','ex_my_code_template.cgt')
set_param('ex_ext_ctrl_alg','ERTHdrFileBannerTemplate','ex_my_code_template.cgt')
set_param('ex_ext_ctrl_alg','ERTDataSrcFileTemplate','ex_my_code_template.cgt')
set_param('ex_ext_ctrl_alg','ERTDataHdrFileTemplate','ex_my_code_template.cgt')

Generate and Inspect Code

Because the external code already defines a main function, select Configuration Parameters >
Generate code only and clear Configuration Parameters > Generate an example main
program.

set_param('ex_ext_ctrl_alg','GenCodeOnly','on')
set_param('ex_ext_ctrl_alg','GenerateSampleERTMain','off')

Generate code from the model.

rtwbuild('ex_ext_ctrl_alg')

In the code generation report, inspect the generated files. The code meets the requirements. For
example, ex_ext_ctrl_sigs.c defines the control output signals, CONTR_SIG_FLOW and
CONTR_SIG_TEMP.

file = fullfile('ex_ext_ctrl_alg_ert_rtw','ex_ext_ctrl_sigs.c');
rtwdemodbtype(file,'dataPath_flow_T CONTR_SIG_FLOW;',...
    'dataPath_temp_T CONTR_SIG_TEMP;',1,1)

The setpoint parameters appear in ex_ext_ctrl_params.c.

file = fullfile('ex_ext_ctrl_alg_ert_rtw','ex_ext_ctrl_params.c');
rtwdemodbtype(file,'const dataPath_flow_T PARAM_setpoint_flow = 3.0;',...
    'const dataPath_temp_T PARAM_setpoint_temp = 2.0;',1,1)

The file ex_ext_ctrl_alg.c defines global variables to store state data. The variables follow the
naming scheme that you specified. Code is similar to the following:

dataPath_temp_T ex_ext__Integrator_DSTATE_datag;
dataPath_flow_T ex_ext_c_Integrator_DSTATE_data;
dataPath_temp_T ex_ext_ctrl_Filter_DSTATE_datad;
dataPath_flow_T ex_ext_ctrl__Filter_DSTATE_data;

In the same file, the model execution function, ex_ext_ctrl_alg_step, creates local function
variables to store temporary calculations. The variables follow the naming scheme that you specified.
Code is similar to the following:
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dataPath_flow_T Diff_local;
dataPath_flow_T FilterCoefficient_local;
dataPath_temp_T Diff1_local;
dataPath_temp_T FilterCoefficient_locali;

Some of the global and local variable names contain extra mangling characters that prevent name
clashes. These extra characters correspond to the $M token that you specified in the naming schemes.

The generated code files are in the generated folders ex_ext_ctrl_alg_ert_rtw and slprj. You
must configure file management systems and build tools to use these folders and files.

See Also

Related Examples
• “Choose an External Code Integration Workflow” on page 56-3
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Control Data and Function Interface in Generated Code” on page 34-44
• “Configure Generated Code According to Interface Control Document Specifications” on page

38-55
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Specify Templates For Code Generation” on page 53-44
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Configure Generated Code According to Interface Control
Document Specifications

This example shows how to configure code generation settings for a model according to specifications
in an interface control document (ICD). The example also shows how to store shared Simulink
variables and data objects in a data dictionary.

An ICD describes the data interface between software components. To exchange and share data, the
components declare and define global variables that store signal and parameter values according to
the ICD. The ICD names the variables and lists characteristics such as data type, physical units, and
parameter values. When you create component models in Simulink, you can configure the models
such that the generated code conforms to the ICD. For example, you can use the ICD as a reference
source while configuring models interfactively or you can automate configuraiton by using a script to
import data from an ICD.

Explore Interface Control Document

In Microsoft® Excel® or another compatible program, open the ex_ICD_PCG.xlsx workbook and
review the contents of the worksheets.

open ex_ICD_PCG.xlsx

• Signals worksheet. Each row represents a signal that crosses the interface boundary. Inspect
the cell values in the worksheet. The Owner column identifies the name of the component that
allocates memory for a signal. The DataType column names the signal data type in memory. For
example, the worksheet uses the expression Bus: EngSensors to name the structure type
EngSensors.

• Parameters worksheet. The Value column lists the value of each parameter. If the value of a
parameter is nonscalar, the value is stored in its own separate worksheet, which has the same
name as the parameter.

• Numeric Types worksheet. Each row represents a named numeric data type. In this ICD, the
data uses fixed-point data types (Fixed-Point Designer). The IsAlias column indicates whether
the C code uses the name of the data type (for example, s16En3) or uses the name of the primitive
integer data type that corresponds to the word length (such as short). The DataScope column
indicates whether the generated code exports or imports the data type definition.

• Structure Types worksheet. Each row represents a structure type or a field of a structure
type. For structure types, the value in the DataType column is struct. Subsequent rows that do
not use struct represent fields of the preceding structure type. This ICD defines structure type,
EngSensors, with four fields: throttle, speed, ego, and map.

• Enumerated Types worksheet. Similar to the Structure Types worksheet, each row
represents an enumerated type or an enumeration member. This ICD defines enumerated type
sldemo_FuelModes.

Explore External Code

Some data items in the ICD belong to other_component, which is a component that exists outside of
MATLAB. Open and explore the content of these example files, which define and declare the external
data:

edit ex_inter_types.h
edit ex_inter_sigs.c
edit ex_inter_sigs.h
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Explore Example Model

In this example, you generate code from the controller model rtwdemo_fuelsys_dd_controller.
Open your copy of the model.

open_system('rtwdemo_fuelsys_dd_controller')

Some signals in the controller model have names, for example, the input signal sensors. Some block
parameters in the model refer to Simulink.Parameter objects in a data dictionary. For example, in
the airflow_calc subsystem, the Pumping Constant block uses the parameter objects PumpCon,
SpeedVect, and PressVect. These parameter objects set the values of the corresponding block
parameters. You can apply code generation settings to the signals and parameter objects.

The controller model is linked to data dictionary rtwdemo_fuelsys_dd_controller.sldd. Explore
the data dictionary.

1 In the lower-left corner of the controller model, click the model data badge.
2 Click the External Data link.
3 In the Model Explorer Model Hierarchy pane, expand the nodes

rtwdemo_fuelsys_dd_controller, External data, and rtwdemo_fuelsys_dd_controller.
4 Select Design Data.

The dictionary stores:

• Parameter objects
• Simulink.NumericType objects, such as u8En7
• Simulink.Bus object, EngSensors

Configure Model Design Data According to ICD

1 Open the ICD spreadsheet, if not open already.
2 In the Simulink Editor window for the controller model, navigate to the root level of the model.
3 On the Modeling tab, click Model Data Editor.
4 In the Model Data Editor, click the Change scope button. The Model Data Editor shows

information about data items in the model subsystems.
5 Click the Show/refresh additional information button. The Model Data Editor shows

information about data objects (the Simulink.Parameter objects in the data dictionary) that
the model uses.

Configure Design Settings for Signals

1 In the ICD, click the Signals tab.
2 In the Model Data Editor, click the Inports/Outports tab.
3 Make sure that the configuration settings for Inport block sensors matches the ICD

specification. Data Type must be set to Bus: EngSensors.
4 Make sure that the configuration settings for Outport block fuel_rate match the ICD

specification. Data Type must be set to s16En7. Min must be set to 0.8000. Max must be set
to 1.7000. Unit must be set to g/s.

5 Make sure that the configuration settings for signal fuel_mode match the ICD specification.
Because fuel_mode is an output signal of a Stateflow chart, you must use Model Explorer to
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configure the design settings. In the model, navigate into the Stateflow chart. Open Model
Explorer. In the Model Explorer Contents pane (the middle pane), select fuel_mode. Data Type
must be set to Enum:sld_FuelModes.

Configure Design Settings for Parameters

1 In the ICD, click the Parameters tab.
2 Navigate to the root level of the control model.
3 In the Model Data Editor, click the Parameters tab.
4 Use the Filter contents box to search for parameter PressEst. The Model Data Editor shows

two rows: one row that corresponds to parameter object PressEst and one row that
corresponds to the block parameter that uses PressEst.

5 Make sure that the configuration settings for parameter PressEst match the ICD specification.
Data Type must be u8En7. Value must be a 19x45 matrix of numeric values.

6 Make sure that the Data Type and Value settings for parameters PumpCon, SpeedEst,
ThrotEst, and RampRateKiz match the ICD specification.

Configure Design Settings for Numeric Types

1 In the ICD, click the Numeric Types tab.
2 If the Model Explorer is not open, open it.
3 In the Model Hierarchy pane, navigate to the design data in the data dictionary for the

controller model (rtwdemo_fuelsys_dd_controller> External
Data>rtwdemo_fuelsys_dd_controller>Design Data).

4 In the Contents (middle) pane, select the Simulink.NumericType object u8En7. This object
represents one of the typedef statements in ex_inter_types.h.

5 In the right pane, on the Design tab, confirm that the setting for Data type mode aligns with
the ICD specification.

6 Make sure that the design configuration for numeric types s16En3, s16En7, and s16En15
matches the ICD specification.

Configure Design Settings for Structures

1 In the ICD, click the Structure Types tab.
2 In the Model Explorer Contents pane, select EngSensors. This Simulink.Bus object

represents the structure type defined in ex_inter_types.h.
3 Confirm that the data type configuration aligns with the ICD specification. In the right pane, on

the Design tab, or in the Bus Editor, adjust the bus signal configurations (for example, settings
for Min and Max) to align with the ICD specification.

Configure Design Settings for Enumerated Types

1 In the ICD, click the Enumerated Types tab.
2 Open the file sld_FuelModes.m, which defines the class for the enmerated type

sld_FuelModes.
3 Confirm that the class definitnion aligns with the ICD specification. In the file sld_FuelModes.m,

adjust member names and underlying integer values to align with the ICD specification.
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Configure Model for Code Generation According to ICD

1 Open the ICD spreadsheet, if not open already.
2 Open the Embedded Coder app.

Configure Code Generation Settings for Inport and Outport Blocks

1 In the ICD, click the Signals tab. The Owner column in the ICD implies that a different
component (other_componnent), not rtwdemo_fuelsys_dd_controller, provides the code
definition of the sensors variable.

2 Include the C source code file that defines the variable sensors. In the Simulink Editor, on the C
Code tab, select Settings> C/C++ Code generation settings. Make sure that the code
generation custom code parameter Source files is set to ex_inter_sigs.c.

3 In the Simulink Editor, on the C Code tab, select Code Interface> Individual Element Code
Mappings.

4 In the Code Mappings editor, click the Inports tab.
5 Select the row for sensors. Because the source code definition is provided in the external file

ex_inter_sigs.c, which you configured in step 2, Storage class must be set to
ImportFromFile.

6 In the Property Inspector, expand Code. Check that the HeaderFile property setting matches
the ICD specification, ex_inter_sigs.h. Make sure that a value is specified for the Identifier
property. This property specifes the variable name for the data element in the generated code.

7 In the Code Mappings editor, click the Outports tab.
8 Select the row for fuel_rate. Because the ICD specifies rtwdemo_fuelsys_dd_controller

as the owner of fuel_rate, Storage Class must be set to ExportToFile.
9 In the Property Inspector, expand Code. Make sure that the settings for properties HeaderFile,

DefinitionFile, and Owner match the ICD specifications global_data.h, signals.c, and
rtwdemo_fuelsys_dd_controller, respectively. Make sure that a value is specified for the
Identifier property.

Configure Code Generation Settings for Signals

1 In the Code Mappings editor, click the Signals/States tab. The third signal listed on the Signals
tab of the ICD is fuel_mode.

2 Add the fuel_mode signal to the model code mappings. In the model diagram, select signal
fuel_mode. Place your cursor on the ellipsis that appears above or below the signal line to open
the action bar. Click the Add selected signals to code mappings button. In the Code Mappings
editor, the Signals node expands and lists the signal that you added. The Storage Class setting
must indicate that the signal resolves to a signal object and that the storage class for the object
is set to ExportToFile. Because the signal is associated with a signal object, you must use the
Model Explorer to confirm that the code generation configuration aligns with the ICD
specification.

3 Open the Model Explorer. In the Model Hierarchy pane, navigate to the design data in the data
dictionary for the controller model (rtwdemo_fuelsys_dd_controller> External Data>
rtwdemo_fuelsys_dd_controller> Design Data). In the Contents pane, select fuel_mode.

4 In the right pane, click the Code Generation tab. Storage class must be set to ExportToFile.
Confirm that properties HeaderFile, DefintionFile, and Owner match the ICD specifications
global_data.h, signals.c, and rtwdemo_fuelsys_dd_controller, respectively.
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Configure Code Generation for Parameters

1 In the ICD, click the Parameters tab.
2 In the Code Mappings editor, click the Paramters tab.
3 Use the Filter contents box to search for parameter PressEst. The Code Mappings editor

shows a row that corresponds to parameter object PressEst. Because the ICD specifies
rtwdemo_fuelsys_dd_controller as the owner of PressEst, Storage Class should be set
to ExportToFile.

4 In the Property Inspector, expand Code. Check that the settings for properties HeaderFile,
DefinitionFile, and Owner match the ICD specifications global_data.h, params.c, and
rtwdemo_fuelsys_dd_controller, respectively. Also, make sure that a value is specified for
the Identifier property.

5 Check the Storage Class, HeaderFile, DefinitionFile, Identifier, and Owner settings for
parameters PumpCon, SpeedEst, ThrotEst, and RampRateKiz.

Configure Code Generation for Numeric Types

1 In the ICD, click the Numeric Types tab.
2 If the Model Explorer is not open, open it.
3 In the Model Hierarchy pane, navigate to the design data in the data dictionary for the

controller model (rtwdemo_fuelsys_dd_controller> External Data>
rtwdemo_fuelsys_dd_controller> Design Data).

4 In the Contents pane, select the Simulink.NumericType object u8En7. This object represents
one of the typedef statements in ex_inter_types.h.

5 In the right pane, click the Code Generation tab. Confirm that the settings for Data scope and
Header file align with the ICD specifications, Imported and ex_inter_types.h, respectively.

6 Check and adjust the code generation configuration for numeric types s16En3, s16En7, and
s16En15.

Configure Code Generation for Structures

1 In the ICD, click the Structure Types tab.
2 In the Model Explorer Contents pane, select EngSensors. This Simulink.Bus object

represents the structure type defined in ex_inter_types.h.
3 In the right pane, click the Code Generation tab. Confirm that the settings for Data scope and

Header file align with the ICD specifications, Imported and ex_inter_types.h, respectively.

Generate and Inspect Code

1. Generate code for the controller model.

slbuild('rtwdemo_fuelsys_dd_controller')

### Starting build procedure for: rtwdemo_fuelsys_dd_controller
### Successful completion of build procedure for: rtwdemo_fuelsys_dd_controller

Build Summary

Top model targets built:

Model                          Action                       Rebuild Reason                   
=============================================================================================
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rtwdemo_fuelsys_dd_controller  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 1m 21.119s

2. Inspect the generated code. The generated header file
rtwdemo_fuelsys_dd_controller_types.h:

• Includes (#include) the external header file ex_inter_types.h, which defines numeric data
types u8En7, s16En3, and s16En7 and the structure type EngSensors

• Defines the enumeration sld_FuelModes

file = fullfile('rtwdemo_fuelsys_dd_controller_ert_rtw',...
    'rtwdemo_fuelsys_dd_controller_types.h');
rtwdemodbtype(file,'#include "ex_inter_types.h"','} sld_FuelModes;',1,1)

#include "ex_inter_types.h"

/* Model Code Variants */
#ifndef DEFINED_TYPEDEF_FOR_sld_FuelModes_
#define DEFINED_TYPEDEF_FOR_sld_FuelModes_

typedef enum {
  LOW = 1,                             /* Default value */
  RICH,
  DISABLED
} sld_FuelModes;

The file rtwdemo_fuelsys_dd_controller_private.h includes the header file
ex_inter_sigs.h. This external header file contains the extern declaration of the signal sensors,
which a different software component owns.

The data header file global_data.h declares the exported parameters and signals that the ICD
specifies. To share this data, other components can include this header file.

file = fullfile('rtwdemo_fuelsys_dd_controller_ert_rtw','global_data.h');
rtwdemodbtype(file,'/* Exported data declaration */',...
    'fuel_rate',1,1)

/* Exported data declaration */

/* Declaration for custom storage class: ExportToFile */
extern real32_T PressEst[855];   /* Referenced by: '<S6>/Pressure Estimation' */
extern real32_T PumpCon[551];       /* Referenced by: '<S1>/Pumping Constant' */
extern real32_T RampRateKiz[25];       /* Referenced by: '<S1>/Ramp Rate Ki' */
extern real32_T SpeedEst[1305];     /* Referenced by: '<S7>/Speed Estimation' */
extern real32_T ThrotEst[551];   /* Referenced by: '<S8>/Throttle Estimation' */
extern sld_FuelModes fuel_mode;        /* '<Root>/control_logic' */
extern real32_T fuel_rate;             /* '<Root>/fuel_rate' */

The algorithm code is in the model step function in the file rtwdemo_fuelsys_dd_controller.c.
The algorithm uses the global data that the ICD identifies. For example, the algorithm uses the value
of the signal fuel_mode in a switch block to control the flow of execution.

file = fullfile('rtwdemo_fuelsys_dd_controller_ert_rtw',...
    'rtwdemo_fuelsys_dd_controller.c');
rtwdemodbtype(file,'/* End of MultiPortSwitch: ''<S9>/Multiport Switch'' */',...
    '/* Outport: ''<Root>/fuel_rate'' incorporates:',0,0)
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  /* SwitchCase: '<S10>/Switch Case' */
  switch (fuel_mode) {
   case LOW:
    /* Outputs for IfAction SubSystem: '<S10>/low_mode' incorporates:
     *  ActionPort: '<S12>/Action Port'
     */
    /* DiscreteFilter: '<S12>/Discrete Filter' incorporates:
     *  DiscreteIntegrator: '<S1>/Discrete Integrator'
     */
    denAccum = rtDWork.DiscreteIntegrator_DSTATE - -0.7408F *
      rtDWork.DiscreteFilter_states_g;

bdclose('rtwdemo_fuelsys_dd_controller')
Simulink.data.dictionary.closeAll('rtwdemo_fuelsys_dd_controller.sldd','-discard')

Import ICD Specifications into Simulink

You can use a MATLAB script to import data settings from the ICD into variables in the Simulink base
workspace.

1. Open and inspect the example script ex_importICD_PCG.m.

edit ex_importICD_PCG

The script:

• Imports the data from each worksheet of the ICD into variables in the base workspace.
• Uses the imported data to configure design and code generation properties of Simulink.Signal

and Simulink.Parameter objects in the base workspace.

If the base workspace already contains a data object that corresponds to a data element in the ICD,
the script configures properties of the existing object. If the object does not exist, the script creates
the object.

2. Load the model and run the script.

load_system('rtwdemo_fuelsys_dd_controller')
run('ex_importICD_PCG')

3. Regenerate and inspect the code.

slbuild('rtwdemo_fuelsys_dd_controller')

### Starting build procedure for: rtwdemo_fuelsys_dd_controller
### Successful completion of build procedure for: rtwdemo_fuelsys_dd_controller

Build Summary

Top model targets built:

Model                          Action                       Rebuild Reason                   
=============================================================================================
rtwdemo_fuelsys_dd_controller  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 39.824s
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Considerations

• When you make changes to an ICD, you can reuse your import script to reconfigure the model.
• If you use a script to import data from an ICD to the base workspace, consider migrating the data

objects and variables to a data dictionary. A data dictionary permanently stores and tracks
changes to data objects and variables. For example, you can import the definition of enumerated
type sld_FuelModes into the controller model dictionary. See “Import and Export Dictionary
Data” and “Enumerations in Data Dictionary”.

• You can store configuration settings for signal and state data elements, such as data types,
minimum and maximum values, and physical units inside or outside of model files.
Simulink.Signal objects store the configuration settings outside of a model file. Alternatively,
you can store the configuration settings in the model file by using block and port parameters that
you can access through the Model Data Editor, Property Inspector, and other dialog boxes. See
“Store Design Attributes of Signals and States”.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Replace and Rename Data Types to Conform to Coding Standards” on page 36-22
• “Control Data and Function Interface in Generated Code” on page 34-44
• “Data Import and Export”
• “What Is a Data Dictionary?”
• “Integrate External Application Code with Code Generated from PID Controller” on page 38-46
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Generate Local Variables with Localizable Storage Class
For signals, if possible, generate variables that are local to functions rather than in global storage.
Generating local variables prevents the code generator from implementing optimizations that remove
these variables from the generated code. Local variables improve observability, readability, and are
helpful in debugging the generated code.

Minimizing the use of global variables by using local variables interacts with stack usage control. For
example, stack size can determine the number of local and global variables that the code generator
can allocate in the generated code. For more information, see “Customize Stack Space Allocation”.

Example Model
The model rtwdemo_localizable_csc contains two signals that have a Localizable storage
class. In the Latching subsystem, the signal with the label Latch has a Localizable storage class.
In the Debug subsystem, the signal with the label Debug has a Localizable storage class.

Generate Code with Localizable Storage Class
1 Open the model.

 Generate Local Variables with Localizable Storage Class

38-63



model='rtwdemo_localizable_csc';
open_system(model);

2 To observe the specification, open the Code Mappings editor. On the C Code tab, select Code
Interface > Individual Element Code Mappings.

3 On the Signals/States tab, expand Signals. The storage class for signals Latch and Debug is
set to Localizable.

4 Generate and view the code. The Debug_b function contains this code:
static void Debug_b(const real_T rtu_In1[6], const real_T rtu_In2[6], real_T
                    rtd_A[6])
{
  real_T Debug;
  int32_T i;
  for (i = 0; i < 6; i++) {
    Debug = rtu_In1[i] * rtu_In2[i];
    rtd_A[i] += Debug;
  }
}

The Latching function contains this code:
static void Latching(const real_T rtu_In1[36], real_T rty_Out1[6], real_T
                     rty_Out2[6], real_T rtd_A[6])
{
  real_T Latch[6];
  int32_T i;
  int32_T i_0;
  for (i = 0; i < 6; i++) {
    Latch[i] = rtd_A[i];
    rty_Out2[i] = -Latch[i];
  }

  for (i = 0; i < 6; i++) {
    rty_Out1[i] = 0.0;
    for (i_0 = 0; i_0 < 6; i_0++) {
      rty_Out1[i] += rtu_In1[6 * i_0 + i] * Latch[i_0];
    }
  }
}

Both functions contain variables for holding intermediate values. The Debug_b function contains
the variable Debug. The Latching function contains the variable Latch.

Generate Code Without Localizable Storage Class
1 Change the signal storage class from Localizable to ExportToFile. In the Code Mappings

editor, for each signal, set the storage class to ExportToFile.
2 Generate and view the code. The rtwdemo_localizable_csc.c file contains these two global

variable declarations:

real_T Debug[6];
real_T Latch[6];

The Debug_b function contains this code:
static void Debug_b(const real_T rtu_In1[6], const real_T rtu_In2[6], real_T
                    rtd_A[6])
{
  int32_T i;
  for (i = 0; i < 6; i++) {
    Debug[i] = rtu_In1[i] * rtu_In2[i];
    rtd_A[i] += Debug[i];
  }
}

The Latching function contains this code:
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static void Latching(const real_T rtu_In1[36], real_T rty_Out1[6], real_T
                     rty_Out2[6], real_T rtd_A[6])
{
  int32_T i;
  int32_T i_0;
  for (i = 0; i < 6; i++) {
    Latch[i] = rtd_A[i];
    rty_Out2[i] = -Latch[i];
  }

  for (i = 0; i < 6; i++) {
    rty_Out1[i] = 0.0;
    for (i_0 = 0; i_0 < 6; i_0++) {
      rty_Out1[i] += rtu_In1[6 * i_0 + i] * Latch[i_0];
    }
  }
}

The code readability and observability is the same as with the Localizable storage class
specification except the labeled signals are global variables.

3 Remove the Debug and Latch signals from the code mappings. In the Code Mappings editor,
select each signal and click the Remove Signal button.

4 Save the model.
5 Generate and review the code. The Debug_b function contains this code:

static void Debug(const real_T rtu_In1[6], const real_T rtu_In2[6], real_T
                  rtd_A[6])
{
  int32_T i;
  for (i = 0; i < 6; i++) {
    rtd_A[i] += rtu_In1[i] * rtu_In2[i];
  }
}

The Latching function contains this code:
static void Latching(const real_T rtu_In1[36], real_T rty_Out1[6], real_T
                     rty_Out2[6], real_T rtd_A[6])
{
  int32_T i;
  int32_T i_0;
  for (i = 0; i < 6; i++) {
    rty_Out2[i] = -rtd_A[i];
    rty_Out1[i] = 0.0;
    for (i_0 = 0; i_0 < 6; i_0++) {
      rty_Out1[i] += rtu_In1[6 * i_0 + i] * rtd_A[i_0];
    }
  }
}

Without the Localizable or ExportToFile storage classes, the code generator removes the
Debug and Latch variables. Without these variables, the readability and observability of the
generated code decreases.

Additional Information
• For the code generator to localize signals with the Localizable storage class specification,

select model configuration parameter Enable Local Block Outputs. This parameter is on by
default.

• You can specify the same Localizable storage class on two signals that are in different reusable
subsystems. Therefore, you can create a library block from a reusable subsystem with a
Localizable storage class specification.

• The code generator does not create a local variable for a signal that must stay global. A few cases
in which the code generator cannot localize a signal are:
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• Input and output signals of a nonreusable subsystem even when the Function interface
parameter is set to Allow arguments (Optimized).

• Signal is holding a state because its receiver and drive blocks execute at different rates.
• Localizable specification is on a signal that crosses the boundary of a conditionally executed

subsystem.

See Also

More About
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
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Data Object Wizard in Embedded Coder

39



Create Data Objects for Code Generation with Data Object
Wizard

To specify code generation options for signal lines, block parameters, and states in a model, you can
use data objects that you store in a workspace or data dictionary. For basic information about data
objects, see “Data Objects”.

You can use the Data Object Wizard to create data objects for:

• New or existing models that do not use data objects.
• Existing models to which you have added signal lines or blocks.

This example shows how to use the Data Object Wizard to create and configure data objects for code
generation from the built-in package Simulink.

Create Data Objects

Open the example model rtwdemo_configinterface.

open_system('rtwdemo_configinterface')

The model creates numeric variables in the base workspace. Blocks in the model use these variables
to set parameter values (such as the Gain parameter of a Gain block). Some of the signals and block
states in the model have explicit names, such as input1.
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On the Modeling tab, under Design, click Data Object Wizard.

In the Data Object Wizard, click Find. The wizard proposes the creation of Simulink.Parameter
objects to replace the variables and the creation of Simulink.Signal objects to represent the
signals and states.
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The wizard finds only signals, parameters, data stores, and states whose storage class is set to Auto.
For example, if you use the Signal Properties dialog box to specify a storage class other than Auto for
a signal line, the wizard does not propose a data object.

Click Select All.

Click Create. The data objects appear in the base workspace.

For detailed information about the options that you can choose in the Data Object Wizard, see
“Create Data Objects for a Model Using Data Object Wizard”.

Set Storage Class for Data Objects

Storage classes determine how the generated code uses variables to represent signals, parameters,
and states. For data objects from the built-in package Simulink, the default storage class is Auto. To
specify storage classes for the new data objects, use the Model Explorer.
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Open the Model Explorer.

In the Model Hierarchy pane, select Base Workspace.

In the Contents pane, from the drop-down list Column View, select Storage Class.

Select all of the new data objects. For example, select the object input1, hold Shift, and select the
object X.

Set the property StorageClass for all of the data objects to ExportToFile. To change the storage
class for all of the selected objects, in the StorageClass column, click any of the objects. In the drop-
down list, select ExportToFile. The change that you make propagates to all of the selected objects.

Specify the HeaderFile property for all of the objects as myExportedHdrFile.h.

In the model, set Configuration Parameters > Code Generation > System target file to
ert.tlc. With this setting, the code generator honors storage classes such as ExportToFile.

Generate and Inspect Code

Generate code from the model.

### Starting build procedure for: rtwdemo_configinterface
### Successful completion of code generation for: rtwdemo_configinterface

Build Summary

Top model targets built:
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Model                    Action          Rebuild Reason                                    
===========================================================================================
rtwdemo_configinterface  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.657s

In the code generation report, view the generated file myExportedHdrFile.h. The file contains
extern declarations for the global variables that correspond to the data objects.

/* Exported data declaration */
/* Declaration for custom storage class: ExportToFile */
extern real_T X;

View the file rtwdemo_configinterface.c. The file contains the definitions for the global
variables. The code assigns numeric values for the variables that correspond to parameter objects.

/* Exported data definition */

/* Definition for custom storage class: ExportToFile */
real_T X;

See Also
Simulink.Parameter | Simulink.Signal

Related Examples
• “Data Objects”
• “C Code Generation Configuration for Model Interface Elements”
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
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Entry-Point Functions and Scheduling in
Simulink Coder

• “Configure Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks”
on page 40-2

• “Generate C++ Class Interface to Model or Subsystem Code” on page 40-9
• “Execution of Code Generated from a Model” on page 40-12
• “Rapid Prototyping Model Functions” on page 40-21
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Configure Entry-Point Function Interfaces for Simulink
Function and Function Caller Blocks

With Embedded Coder, you can customize the generated C and C++ function interfaces for Simulink
Function and Function Caller blocks. Function code interface configuration supports easier
integration of generated code with functions or function calls in external code and customizations for
coding standards or design requirements.

You can customize generated C and C++ function interfaces for:

• Global Simulink functions
• Exported scoped Simulink functions

You cannot customize the generated function interface for a scoped Simulink Function block that is
not located at the root level of a model. For more information, see “Scoped and Global Simulink
Function Blocks Overview”.

By opening a dialog box from a selected Simulink Function or Function Caller block, you can
customize the function prototype generated for that block. Your changes for the selected block also
update other corresponding Simulink Function and Function Caller blocks in the model. The function
visibility, global or scoped, set in the function Trigger Port block determines which function attributes
you can modify:

• For a global function, you can change the function name, and the names, type qualifiers, and order
of function arguments.

• For an exported scoped function, you can change the argument type qualifiers and the order of
arguments. You cannot change the function and argument names.

Your changes do not graphically alter the model and do not affect the Simulink function prototype
defined in the block.

Embedded Coder supports Simulink function code interface configuration for models configured with
ERT-based system target files, except for AUTOSAR system target files.

Configure Generated C Function Interface for Global Simulink Function
Block
This example shows how to customize the C function interface that the code generator produces for a
global Simulink Function block.

1 Open example model rtwdemo_functions. Save a copy of the model to a writable location.
2 In the apps gallery, open the Embedded Coder app.
3 On the C Code tab, select Code Interface > Individual Element Code Mappings.
4 In the Code Mappings editor, click the Functions tab.
5 In the row for Simulink Function:f3, click the function preview hyperlink. The C/C++

Function Interface dialog box shows Simulink function prototype as y = f3(u) and C/C++
function prototype as void f3(rtu_u, * rty_y). The preview for C/C++ function
prototype is updated as you make changes.
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6 Configure the function name and arguments.

• Modify the function and argument identifier names. Model configuration parameter
Subsystem method arguments defines the default naming rule for Simulink Function
arguments. Changes that you make in the C/C++ Function Interface dialog box override the
default naming rule.

In the C/C++ function name field, and in the C/C++ Identifier Name column for each
Simulink function argument, enter a custom name or naming rule. Specify valid C-identifier
characters, identifier format macros, or a combination of characters and macros. For this
example, name the function function3 and, for the arguments, enter naming rule $N$M.

To see tips about available macros, place your cursor over C/C++ function name and C/C+
+ Identifier Name. For more information about identifier naming rules, see “Identifier
Format Control” on page 53-15.

• For argument u, set C/C++ Type Qualifier to Pointer to const.
• Reorder the arguments. Drag the y argument row above the u argument row.
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7 Verify your changes by checking the function prototype preview.
8 Click Apply. Your modifications, whether made to a Simulink Function block or a Function Caller

block, affect code generation for the Simulink Function block and corresponding Function Caller
blocks in the model.

Optionally, you can change C/C++ return argument from void to y. In that case, the C
function prototype is y = function3(const * u).

9 Save your changes by clicking OK.
10 Save the model.
11 Make sure that the Simulink Function block is not selected. Then, generate code for the model.
12 In the Code view, open the generated file rtwdemo_functions.c and search for function3.

The generated function code reflects the changes to the generated C function prototype.
void function3(real_T *y, const real_T *u)
{
  rtY.TicToc10 = rtDWork.Delay_DSTATE;

  rtDWork.Delay_DSTATE = (int8_T)(int32_T)-(int32_T)rtY.TicToc10;

  adder(rtB.Subtract, rtU.U2, *u, &rtB.FunctionCaller);
  
  *y = rtB.FunctionCaller;
}

Configure Generated C Function Interface for Exported Scoped
Simulink Function Block
This example shows how to customize the C function interface that the code generator produces for
an exported, scoped Simulink Function block.

For an exported, scoped function, you can modify the generated return argument, the argument type
qualifiers, and the order of arguments. You cannot change the generated function name and
argument names.
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1 Open the model rtwdemo_functions. Save it to a writable location.
2 Change the visibility of the global function f3 from global to scoped. Open the Simulink Function

block f3. Inside the function block, double-click the Trigger Port block f3. In the block
parameters dialog box, set Function visibility to scoped. Click Apply and OK.

3 In the apps gallery, open the Embedded Coder app.
4 In the C Code tab, click the Code Mappings - C tab.
5 In the Code Mappings editor, click the Functions tab.
6 In the row for function f3, click the function preview hyperlink. The C/C++ Function Interface

dialog box shows Simulink function prototype as y = f3(u) and C/C++ function prototype
as y = rtwdemo_functions_f3(rtu_u). The preview for C/C++ function prototype is
updated as you make changes.

For models that you configure for C multi-instantiable code, the interface preview for scoped
Simulink functions includes a self argument. The self argument is a pointer to a version of the
real-time model (RT_MODEL) data structure that stores multi-instance data associated with
reusable functions.

If model configuration parameter Code interface packaging is set to Reusable function and
Total number of instances allowed per top model is set to Multiple, the argument appears
as self, indicating that the code generator produces a self structure.

If model configuration parameter Code interface packaging is set to Reusable function or
Total number of instances allowed per top model is set to Multiple, the argument appears
as [self], indicating that the argument is optional. The code generator produces a self
structure only if you use the model as a top model and Code interface packaging is set to
Reusable function or if you use the model as a referenced model and Total number of
instances allowed per top model is set to Multiple.

For more information about configuring a model for multi-instantiable code generation, see
“Generate Reentrant Code from Simulink Function Blocks” on page 7-23.

7 Configure the arguments. For this example, configure the u argument. Set C/C++ type Qualifier
to Pointer to const.
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8 Verify your change by checking the function prototype preview.
9 Click Apply. Your modifications, whether made to a Simulink Function block or a Function Caller

block, affect code generation for the Simulink Function block and corresponding Function Caller
blocks in the model.

Optionally, you can change C/C++ return argument from y to void. In that case, the C
function prototype is void = rtwdemo_functions_f3(* rty_y, const * rtu_u).

10 Save your change by clicking OK.
11 Save the model.
12 Make sure that the Simulink Function block is not selected. Then, generate code for the model.
13 In the Code view, open the generated file rtwdemo_functions.c and search for

rtwdemo_functions_f3. The generated function code reflects the changes to the generated C
function prototype.
real_T rtwdemo_functions_f3(const real_T *rtu_u)
{
  real_T rty_y_0;

  rtY.TicToc10 = rtDWork.Delay_DSTATE;

  rtDWork.Delay_DSTATE = (int8_T)(int32_T)-(int32_T)rtY.TicToc10;

  adder(rtB.Subtract, rtU.U2, *rtu_u, &rtB.FunctionCaller);
  
  rty_y_0 = rtB.FunctionCaller;

  return rty_y_0;
}

Configure Generated C++ Function Interface for Exported Scoped
Simulink Function Block
This example shows how to customize the C++ function interface that the code generator produces
for an exported scoped Simulink Function block.

For an exported scoped function, you can modify the generated return argument, the argument type
qualifiers, and the order of arguments. You cannot change the generated function name and
argument names.

1 Open the model rtwdemo_functions. Save it to a writable work area.
2 Change the visibility of the global function f3 from global to scoped. Open the Simulink Function

block f3. Inside the function block, double-click the Trigger Port block f3. In the block
parameters dialog box, set Function visibility to scoped. Click Apply and OK.

3 In the apps gallery, open the Embedded Coder app.
4 Set the model configuration parameter Language to C++.
5 Open the Configure C/C++ Function Interface dialog box. Right-click the Simulink Function

block f3. In the context menu, select C/C++ Code > Configure C/C++ Function Interface.
The dialog box shows Simulink function prototype as y = f3(u) and C/C++ function
prototype as y = rtwdemo_functions_f3(rtu_u). The preview for C/C++ function
prototype is updated as you make changes.
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6 Configure the arguments. For this example, configure the u argument. Set C/C++ type Qualifier
to Pointer to const.

7 Click Apply. Your modifications, whether made to a Simulink Function block or a Function Caller
block, affect code generation for the Simulink Function block and corresponding Function Caller
blocks in the model.

Optionally, you can change C/C++ return argument from y to void. In that case, the C++
function prototype is void = rtwdemo_functions_f3(* rty_y, const * rtu_u).

8 Save your change by clicking OK.
9 Save the model.
10 Make sure that the Simulink Function block is not selected. Then, generate code for the model.
11 In the Code view, open the generated file rtwdemo_functions.cpp and search for function f3.

The generated function code reflects the changes to the generated C++ function prototype.

real_T rtwdemo_functionsModelClass::f3(const real_T *rtu_u)
{
  real_T rty_y_0;

  rtY.TicToc10 = rtDWork.Delay_DSTATE;

  rtDWork.Delay_DSTATE = static_cast<int8_T>(static_cast<int32_T>
    (-static_cast<int32_T>(rtY.TicToc10)));

  adder(rtB.Subtract, rtU.U2, *rtu_u, &rtB.FunctionCaller);
  
  rty_y_0 = rtB.FunctionCaller;

  return rty_y_0;
}

Simulink Function Code Interface Limitations
• For C++ code generation, global Simulink functions are incompatible with C++ class interfaces

for model entry-point functions.

 Configure Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks

40-7



• Simulink function code interface configuration does not support Simulink functions and function
callers in Stateflow.
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Generate C++ Class Interface to Model or Subsystem Code
To generate a C++ class interface to model code, set model configuration parameter “Code interface
packaging” to C++ class. The generated interface encapsulates required model data into C++ class
attributes and model entry point functions into C++ class methods. The benefits of C++ class
encapsulation include:

• Greater control over access to model data
• Ability to create multiple instances of model classes
• Easier integration of model code into C++ programming environments

C++ class encapsulation also works for right-click builds of nonvirtual subsystems. (For information
on requirements that apply, see “Generate C++ Class Interface to Nonvirtual Subsystem Code” on
page 40-10.)

Generate C++ Class Interface to Model Code
To generate encapsulated C++ class code from a model:

1 Set model configuration parameter Language to C++. This selection also enables C++ class code
interface packaging for the model.

2 Verify that model configuration parameter Code interface packaging is set to C++ class.
3 Examine the setting of Multi-instance code error diagnostic. Leave the parameter at its

default value Error unless you need to alter the severity level for diagnostics displayed when a
model violates requirements for generating multi-instance code.

4 Generate code for the model.
5 Examine the C++ model class code in the generated files model.h and model.cpp. For

example, the following code excerpt from the H file generated for the example model
rtwdemo_secondOrderSystem shows the C++ class declaration for the model.
/* Class declaration for model rtwdemo_secondOrderSystem */
class rtwdemo_secondOrderSystemModelClass {
  /* public data and function members */
 public:
  /* External outputs */
  ExtY_rtwdemo_secondOrderSyste_T rtwdemo_secondOrderSystem_Y;

  /* Model entry point functions */

  /* model initialize function */
  void initialize();

  /* model step function */
  void step();

  /* model terminate function */
  void terminate();

  /* Constructor */
  rtwdemo_secondOrderSystemModelClass();

  /* Destructor */
  ~rtwdemo_secondOrderSystemModelClass();
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  /* Real-Time Model get method */
  RT_MODEL_rtwdemo_secondOrderS_T * getRTM();
...
};

For more information about generating and calling model entry-point functions, see “Configure C
Code Generation for Model Entry-Point Functions”.

Note If you have an Embedded Coder license and you have selected an ERT-based system target file
for your model, use additional Code Generation > Interface pane parameters to customize the
generated C++ class interface.

Generate C++ Class Interface to Nonvirtual Subsystem Code
You can generate C++ class interfaces for right-click builds of nonvirtual subsystems, if the following
requirements are met:

• The model is configured for the C++ language and C++ class code interface packaging.
• The subsystem is convertible to a Model block using the function

Simulink.SubSystem.convertToModelReference. For referenced model conversion
requirements, see the Simulink reference page
Simulink.SubSystem.convertToModelReference.

To configure C++ class interfaces for a subsystem that meets the requirements:

1 Open the containing model and select the subsystem block.
2 Right-click the subsystem and select C/C++ Code > Build This Subsystem.
3 When the subsystem build completes, examine the C++ class interfaces in the generated files

and the HTML code generation report. For more information about generating and calling model
entry-point methods, see “Configure C Code Generation for Model Entry-Point Functions”.

If you have an Embedded Coder license and you have selected an ERT-based system target file for
your model, you can use the MATLAB command RTW.configSubsystemBuild to customize the
generated C++ class interface to subsystem code.

C++ Class Interface Limitations
• Among the data exchange interfaces available on the Interface pane of the Configuration

Parameters dialog box, only the C API interface is supported for C++ class code generation. If
you select External mode or ASAP2 interface, code generation fails with a validation error.

• If a model root inport value connects to a Simscape conversion block, you must insert a Simulink
Signal Conversion block between the root inport and the Simscape conversion block. On the
Simulink Signal Conversion block parameter dialog box, select Exclude this block from 'Block
reduction' optimization.

• You cannot use a C++ class interface in cases when a referenced model cannot have a combined
output/update function. Cases include a model that

• Has a continuous sample time
• Saves states
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See Also

More About
• “Generate Reentrant Code from Top Models”
• “Configure C Code Generation for Model Entry-Point Functions”
• “Execution of Code Generated from a Model”
• “Rapid Prototyping Model Functions”
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Execution of Code Generated from a Model
The code generator produces algorithmic code as defined by your model. You can include external
(for example, custom or legacy) code in a model by using techniques explained in “Choose an
External Code Integration Workflow”.

The code generator also provides an interface that executes the generated model code. The interface
and model code are compiled together to create an executable program. The next figure shows a
high-level object-oriented view of the executable.

The Object-Oriented View of a Real-Time Program

In general, the conceptual design of the model execution driver does not change between the rapid
prototyping and embedded style of generated code. The following sections describe model execution
for single-tasking and multitasking environments both for simulation (non-real-time) and for real
time. For most model code, the multitasking environment provides the most efficient model execution
(that is, fastest sample rate).

The following concepts are useful in describing how model code executes.

• Initialization: model_initialize initializes the interface code and the model code.
• ModelOutputs: Calls blocks in your model that have a sample hit at the current time and has

them produce their output. model_output can be done in major or minor time steps. In major
time steps, the output is a given simulation time step. In minor time steps, the interface integrates
the derivatives to update the continuous states.

• ModelUpdate: model_update calls blocks that have a sample hit at the current point in time and
has them update their discrete states or similar type objects.

• ModelDerivatives: Calls blocks in your model that have continuous states and has them update
their derivatives. model_derivatives is only called in minor time steps.

• ModelTerminate: model_terminate terminates the program if it is designed to run for a finite
time. It destroys the real-time model data structure, deallocates memory, and can write data to a
file.

Program Execution
A real-time program cannot require 100% of the CPU time. This requirement provides an opportunity
to run background tasks during the free time.

Background tasks include operations such as writing data to a buffer or file, allowing access to
program data by third-party data monitoring tools, or updating program parameters.
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It is important, however, that the program be able to preempt the background task so the model code
can execute in real time.

The way the program manages tasks depends on capabilities of the environment in which it operates.

Program Timing
Real-time programs require careful timing of the task invocations (either by using an interrupt or a
real-time operating system tasking primitive) so that the model code executes to completion before
another task invocation occurs. The timing includes time to read and write data to and from external
hardware.

The next figure illustrates interrupt timing.

Task Timing

The sample interval must be long enough to allow model code execution between task invocations.

In the figure above, the time between two adjacent vertical arrows is the sample interval. The empty
boxes in the upper diagram show an example of a program that can complete one step within the
interval and still allow time for the background task. The gray box in the lower diagram indicates
what happens if the sample interval is too short. Another task invocation occurs before the task is
complete. Such timing results in an execution error.

If the real-time program is designed to run forever (that is, the final time is 0 or infinite so that the
while loop never exits), then the shutdown code does not execute.

For more information on how the timing engine works, see “Absolute and Elapsed Time
Computation”.

External Mode Communication
External mode allows communication between the Simulink block diagram and the standalone
program that is built from the generated code. In this mode, the real-time program functions as an
interprocess communication server, responding to requests from the Simulink engine.
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Data Logging in Single-Tasking and Multitasking Model Execution
“Configure Model for Debugging” on page 46-34 explains how you can save system states, outputs,
and time to a MAT-file at the completion of the model execution. The LogTXY function, which
performs data logging, operates differently in single-tasking and multitasking environments.

If you examine how LogTXY is called in the single-tasking and multitasking environments, notice that
for single-tasking LogTXY is called after ModelOutputs. During this ModelOutputs call, blocks that
have a hit at time t execute, whereas in multitasking, LogTXY is called after ModelOutputs(tid=0),
which executes only the blocks that have a hit at time t and that have a task identifier of 0. This
results in differences in the logged values between single-tasking and multitasking logging.
Specifically, consider a model with two sample times, the faster sample time having a period of 1.0
second and the slower sample time having a period of 10.0 seconds. At time t = k*10, k=0,1,2... both
the fast (tid=0) and slow (tid=1) blocks execute. When executing in multitasking mode, when
LogTXY is called, the slow blocks execute, but the previous value is logged, whereas in single-tasking
the current value is logged.

Another difference occurs when logging data in an enabled subsystem. Consider an enabled
subsystem that has a slow signal driving the enable port and fast blocks within the enabled
subsystem. In this case, the evaluation of the enable signal occurs in a slow task, and the fast blocks
see a delay of one sample period; thus the logged values will show these differences.

To summarize differences in logged data between single-tasking and multitasking, differences will be
seen when

• A root outport block has a sample time that is slower than the fastest sample time
• A block with states has a sample time that is slower than the fastest sample time
• A block in an enabled subsystem where the signal driving the enable port is slower than the rate

of the blocks in the enabled subsystem

For the first two cases, even though the logged values are different between single-tasking and
multitasking, the model results are not different. The only real difference is where (at what point in
time) the logging is done. The third (enabled subsystem) case results in a delay that can be seen in a
real-time environment.

Non-Real-Time Single-Tasking Systems
This pseudocode shows the execution of a model for a non-real-time single-tasking system.

main()
{
  Initialization
  While (time < final time)
    ModelOutputs     -- Major time step.
    LogTXY           -- Log time, states and root outports.
    ModelUpdate      -- Major time step.
    Integrate        -- Integration in minor time step for 
                     -- models with continuous states.
      ModelDerivatives
      Do 0 or more
        ModelOutputs
        ModelDerivatives
      EndDo -- Number of iterations depends upon the solver
      Integrate derivatives to update continuous states.
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    EndIntegrate
  EndWhile
  Termination
}

The initialization phase begins first. This consists of initializing model states and setting up the
execution engine. The model then executes, one step at a time. First ModelOutputs executes at time
t, then the workspace I/O data is logged, and then ModelUpdate updates the discrete states. Next, if
your model has continuous states, ModelDerivatives integrates the continuous states' derivatives
to generate the states for time tnew = t + h, where h is the step size. Time then moves forward to tnew
and the process repeats.

During the ModelOutputs and ModelUpdate phases of model execution, only blocks that reach the
current point in time execute.

Non-Real-Time Multitasking Systems
This pseudocode shows the execution of a model for a non-real-time multitasking system.

main()
{
  Initialization
  While (time < final time)
    ModelOutputs(tid=0)   -- Major time step.
    LogTXY                -- Log time, states, and root 
                          -- outports.
    ModelUpdate(tid=0)    -- Major time step.
    Integrate       -- Integration in minor time step for 
                    -- models with continuous states.
      ModelDerivatives
      Do 0 or more
        ModelOutputs(tid=0)
        ModelDerivatives
      EndDo (Number of iterations depends upon the solver.)
      Integrate derivatives to update continuous states.
    EndIntegrate
    For i=1:NumTids
      ModelOutputs(tid=i) -- Major time step.
      ModelUpdate(tid=i)  -- Major time step.
    EndFor
  EndWhile
  Termination
  }

Multitasking operation is more complex than single-tasking execution because the output and update
functions are subdivided by the task identifier (tid) that is passed into these functions. This allows
for multiple invocations of these functions with different task identifiers using overlapped interrupts,
or for multiple tasks when using a real-time operating system. In simulation, multiple tasks are
emulated by executing the code in the order that would occur if preemption did not exist in a real-
time system.

Multitasking execution assumes that task rates are multiples of the base rate. The Simulink product
enforces this when you create a fixed-step multitasking model. The multitasking execution loop is
very similar to that of single-tasking, except for the use of the task identifier (tid) argument to
ModelOutputs and ModelUpdate.
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You cannot use tid values from code generated by a target file and not by Simulink Coder. Simulink
Coder tracks the use of tid when generating code for a specific subsystem or function type. When
you generate code in a target file, this argument cannot be tracked because the scope does not have
subsystem or function type. Therefore, tid becomes an undefined variable and your target file fails
to compile.

Real-Time Single-Tasking Systems
This pseudocode shows the execution of a model in a real-time single-tasking system where the model
is run at interrupt level.

rtOneStep()
{
  Check for interrupt overflow
  Enable "rtOneStep" interrupt
  ModelOutputs    -- Major time step.
  LogTXY          -- Log time, states and root outports.
  ModelUpdate     -- Major time step.
  Integrate       -- Integration in minor time step for models 
                  -- with continuous states.
     ModelDerivatives
     Do 0 or more 
       ModelOutputs
       ModelDerivatives
     EndDo (Number of iterations depends upon the solver.)
     Integrate derivatives to update continuous states.
  EndIntegrate
}

main()
{
  Initialization (including installation of rtOneStep as an 
  interrupt service routine, ISR, for a real-time clock).
  While(time < final time)
    Background task.
  EndWhile
  Mask interrupts (Disable rtOneStep from executing.)
  Complete any background tasks.
  Shutdown
}

Real-time single-tasking execution is very similar to non-real-time single-tasking execution, except
that instead of free-running the code, the rt_OneStep function is driven by a periodic timer
interrupt.

At the interval specified by the program's base sample rate, the interrupt service routine (ISR)
preempts the background task to execute the model code. The base sample rate is the fastest in the
model. If the model has continuous blocks, then the integration step size determines the base sample
rate.

For example, if the model code is a controller operating at 100 Hz, then every 0.01 seconds the
background task is interrupted. During this interrupt, the controller reads its inputs from the analog-
to-digital converter (ADC), calculates its outputs, writes these outputs to the digital-to-analog
converter (DAC), and updates its states. Program control then returns to the background task. These
steps must occur before the next interrupt.
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Real-Time Multitasking Systems
This pseudocode shows how a model executes in a real-time multitasking system where the model is
run at interrupt level.

rtOneStep()
{
  Check for interrupt overflow
  Enable "rtOneStep" interrupt
  ModelOutputs(tid=0)     -- Major time step.
  LogTXY                  -- Log time, states and root outports.
  ModelUpdate(tid=0)      -- Major time step.
  Integrate               -- Integration in minor time step for 
                          -- models with continuous states.
     ModelDerivatives
     Do 0 or more
       ModelOutputs(tid=0)
       ModelDerivatives
     EndDo (Number of iterations depends upon the solver.)
     Integrate derivatives and update continuous states.
  EndIntegrate
  For i=1:NumTasks
    If (hit in task i)
      ModelOutputs(tid=i)
      ModelUpdate(tid=i)
    EndIf
  EndFor
}

main()
{
  Initialization (including installation of rtOneStep as an 
    interrupt service routine, ISR, for a real-time clock).
  While(time < final time)
    Background task.
  EndWhile
  Mask interrupts (Disable rtOneStep from executing.) 
  Complete any background tasks.
  Shutdown
}

Running models at interrupt level in a real-time multitasking environment is very similar to the
previous single-tasking environment, except that overlapped interrupts are employed for concurrent
execution of the tasks.

The execution of a model in a single-tasking or multitasking environment when using real-time
operating system tasking primitives is very similar to the interrupt-level examples discussed above.
The pseudocode below is for a single-tasking model using real-time tasking primitives.

tSingleRate()
{
  MainLoop:
    If clockSem already "given", then error out due to overflow.
    Wait on clockSem
    ModelOutputs            -- Major time step.
    LogTXY                  -- Log time, states and root 
                            -- outports
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    ModelUpdate             -- Major time step
    Integrate               -- Integration in minor time step 
                            -- for models with continuous 
                            -- states.
      ModelDeriviatives
      Do 0 or more
        ModelOutputs
        ModelDerivatives
      EndDo (Number of iterations depends upon the solver.)
      Integrate derivatives to update continuous states.
    EndIntegrate
  EndMainLoop
}

main()
{
  Initialization
  Start/spawn task "tSingleRate".
  Start clock that does a "semGive" on a clockSem semaphore.
  Wait on "model-running" semaphore.
  Shutdown
}

In this single-tasking environment, the model executes as real-time operating system tasking
primitives. In this environment, create a single task (tSingleRate) to run the model code. This task
is invoked when a clock tick occurs. The clock tick gives a clockSem (clock semaphore) to the model
task (tSingleRate). The model task waits for the semaphore before executing. The clock ticks occur
at the fundamental step size (base rate) for your model.

Multitasking Systems Using Real-Time Tasking Primitives
This pseudocode is for a multitasking model using real-time tasking primitives.

tSubRate(subTaskSem,i)
{
  Loop:
    Wait on semaphore subTaskSem.
    ModelOutputs(tid=i)
    ModelUpdate(tid=i)
  EndLoop
}
tBaseRate()
{
  MainLoop:
    If clockSem already "given", then error out due to overflow.
    Wait on clockSem
    For i=1:NumTasks
      If (hit in task i)
        If task i is currently executing, then error out due to 
          overflow.
        Do a "semGive" on subTaskSem for task i.
      EndIf
    EndFor
    ModelOutputs(tid=0)    -- major time step.
    LogTXY                 -- Log time, states and root outports.
    ModelUpdate(tid=0)     -- major time step.
    Loop:                  -- Integration in minor time step for 
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                           -- models with continuous states.
      ModelDeriviatives
      Do 0 or more
        ModelOutputs(tid=0)
        ModelDerivatives
      EndDo (number of iterations depends upon the solver).
      Integrate derivatives to update continuous states.
    EndLoop
  EndMainLoop
}
main()
{
  Initialization
  Start/spawn task "tSubRate".
  Start/spawn task "tBaseRate".

  Start clock that does a "semGive" on a clockSem semaphore.
  Wait on "model-running" semaphore.
  Shutdown
}

In this multitasking environment, the model is executed using real-time operating system tasking
primitives. Such environments require several model tasks (tBaseRate and several tSubRate tasks)
to run the model code. The base rate task (tBaseRate) has a higher priority than the subrate tasks.
The subrate task for tid=1 has a higher priority than the subrate task for tid=2, and so on. The
base rate task is invoked when a clock tick occurs. The clock tick gives a clockSem to tBaseRate.
The first thing tBaseRate does is give semaphores to the subtasks that have a hit at the current
point in time. Because the base rate task has a higher priority, it continues to execute. Next it
executes the fastest task (tid=0), consisting of blocks in your model that have the fastest sample
time. After this execution, it resumes waiting for the clock semaphore. The clock ticks are configured
to occur at the fundamental step size for your model.

Rapid Prototyping and Embedded Model Execution Differences
The rapid prototyping program framework provides a common application programming interface
(API) that does not change between model definitions.

The Embedded Coder product provides a different framework called the embedded program
framework. The embedded program framework provides an optimized API that is tailored to your
model. When you use the embedded style of generated code, you are modeling how you would like
your code to execute in your embedded system. Therefore, the definitions defined in your model
should be specific to your embedded targets. Items such as the model name, parameter, and signal
storage class are included as part of the API for the embedded style of code.

One major difference between the rapid prototyping and embedded style of generated code is that
the latter contains fewer entry-point functions. The embedded style of code can be configured to have
only one function, model_step.

Thus, model execution code eliminates Loop...EndLoop statements and groups ModelOutputs,
LogTXY, and ModelUpdate into a single statement, model_step.

For more information about how generated embedded code executes, see “Configure C Code
Generation for Model Entry-Point Functions” on page 33-112.
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See Also

More About
• “Time-Based Scheduling and Code Generation” on page 28-2
• “Sample Times in Subsystems”
• “Sample Times in Systems”
• “Time-Based Scheduling Example Models” on page 28-35
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Rapid Prototyping Model Functions
Rapid prototyping code defines the following functions that interface with the main program (main.c
or main.cpp):

• Model(): The model registration function. This function initializes the work areas (for example,
allocating and setting pointers to various data structures) used by the model. The model
registration function calls the MdlInitializeSizes and MdlInitializeSampleTimes
functions. These two functions are very similar to the S-function mdlInitializeSizes and
mdlInitializeSampleTimes methods.

• MdlStart(void): After the model registration functions MdlInitializeSizes and
MdlInitializeSampleTimes execute, the main program starts execution by calling MdlStart.
This routine is called once at startup.

The function MdlStart has four basic sections:

• Code to initialize the states for each block in the root model that has states. A subroutine call is
made to the “initialize states” routines of conditionally executed subsystems.

• Code generated by the one-time initialization (start) function for each block in the model.
• Code to enable the blocks in the root model that have enable methods, and the blocks inside

triggered or function-call subsystems residing in the root model. Simulink blocks can have
enable and disable methods. An enable method is called just before a block starts executing,
and the disable method is called just after the block stops executing.

• Code for each block in the model whose output value is constant. The block code appears in
the MdlStart function only if the block parameters are not tunable in the generated code and
if the code generator cannot eliminate the block code through constant folding.

• MdlOutputs(int_T tid): MdlOutputs updates the output of blocks. The tid (task identifier)
parameter identifies the task that in turn maps when to execute blocks based upon their sample
time. This routine is invoked by the main program during major and minor time steps. The major
time steps are when the main program is taking an actual time step (that is, it is time to execute a
specific task). If your model contains continuous states, the minor time steps will be taken. The
minor time steps are when the solver is generating integration stages, which are points between
major outputs. These integration stages are used to compute the derivatives used in advancing the
continuous states.

• MdlUpdate(int_T tid): MdlUpdate updates the states and work vector state information (that
is, states that are neither continuous nor discrete) saved in work vectors. The tid (task identifier)
parameter identifies the task that in turn indicates which sample times are active, allowing you to
conditionally update only states of active blocks. This routine is invoked by the interface after the
major MdlOutputs has been executed. The solver is also called, and model_Derivatives is
called in minor steps by the solver during its integration stages. All blocks that have continuous
states have an identical number of derivatives. These blocks are required to compute the
derivatives so that the solvers can integrate the states.

• MdlTerminate(void): MdlTerminate contains any block shutdown code. MdlTerminate is
called by the interface, as part of the termination of the real-time program.

The contents of the above functions are directly related to the blocks in your model. A Simulink block
can be generalized to the following set of equations.

y = f0(t, xc, xd, u)
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Output y is a function of continuous state xc, discrete state xd, and input u. Each block writes its
specific equation in a section of MdlOutputs.

xd + 1 = fu(t, xd, u)

The discrete states xd are a function of the current state and input. Each block that has a discrete
state updates its state in MdlUpdate.

ẋ = fd(t, xc, u)

The derivatives x are a function of the current input. Each block that has continuous states provides
its derivatives to the solver (for example, ode5) in model_Derivatives. The derivatives are used by
the solver to integrate the continuous state to produce the next value.

The output, y, is generally written to the block I/O structure. Root-level Outport blocks write to the
external outputs structure. The continuous and discrete states are stored in the states structure. The
input, u, can originate from another block's output, which is located in the block I/O structure, an
external input (located in the external inputs structure), or a state. These structures are defined in
the model.h file that the Simulink Coder software generates.

The next example shows the general contents of the rapid prototyping style of C code written to the
model.c file.
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This figure shows a flow chart describing the execution of the rapid prototyping generated code.
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Rapid Prototyping Execution Flow Chart

Each block places code in specific Mdl routines according to the algorithm that it is implementing.
Blocks have input, output, parameters, and states, as well as other general items. For example, in
general, block inputs and outputs are written to a block I/O structure (model_B). Block inputs can
also come from the external input structure (model_U) or the state structure when connected to a
state port of an integrator (model_X), or ground (rtGround) if unconnected or grounded. Block
outputs can also go to the external output structure (model_Y). This figure shows the general
mapping between these items.
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Data View of the Generated Code

The following list defines the structures shown in the preceding figure:

• Block I/O structure (model_B): This structure consists of persistent block output signals. The
number of block output signals is the sum of the widths of the data output ports of the nonvirtual
blocks in your model. If you activate block I/O optimizations, the Simulink and Simulink Coder
products reduce the size of the model_B structure by

• Reusing the entries in the model_B structure
• Making other entries local variables

See “How Generated Code Stores Internal Signal, State, and Parameter Data” for more
information on these optimizations.

Structure field names are determined either by the block's output signal name (when present) or
by the block name and port number when the output signal is left unlabeled.

• Block states structures: The continuous states structure (model_X) contains the continuous state
information for blocks in your model that have continuous states. Discrete states are stored in a
data structure called the DWork vector (model_DWork).

• Block parameters structure (model_P): The parameters structure contains block parameters that
can be changed during execution (for example, the parameter of a Gain block).

• External inputs structure (model_U): The external inputs structure consists of the root-level
Inport block signals. Field names are determined by either the block's output signal name, when
present, or by the Inport block's name when the output signal is left unlabeled.

• External outputs structure (model_Y): The external outputs structure consists of the root-level
Outport blocks. Field names are determined by the root-level Outport block names in your model.

• Real work, integer work, and pointer work structures (model_RWork, model_IWork,
model_PWork): Blocks might have a need for real, integer, or pointer work areas. For example,
the Memory block uses a real work element for each signal. These areas are used to save internal
states or similar information.
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See Also

More About
• “Time-Based Scheduling and Code Generation” on page 28-2
• “How Generated Code Exchanges Data with an Environment”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Function and Class Interfaces in
Embedded Coder

• “Generate Modular Function Code for Nonvirtual Subsystems” on page 41-2
• “Generate Reentrant, Multi-Instance Code” on page 41-19
• “Generate Code for String Blocks by using the Standard C++ String Library” on page 41-23
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Generate Modular Function Code for Nonvirtual Subsystems

About Nonvirtual Subsystem Code Generation
By default, when producing code for a nonvirtual subsystem, the code generator places internal data
associated with a nonvirtual subsystem in the same data structure as internal data for the parent
model. This can make it difficult to trace and test code, particularly for nonreusable subsystems. Also,
in large models containing nonvirtual subsystems, data structures can become large and potentially
difficult to compile.

To generate modular function code for nonvirtual subsystems, including atomic subsystems and
conditionally executed subsystems, use the subsystem block parameter Function with separate
data. This block parameter instructs the code generator to produce a block I/O and DWork data
structure for the nonvirtual subsystem function that is independent from the parent model data
structures. As a result, generated code for the subsystem:

• Is easier to trace.
• Is easier to test.
• Reduces the size of a model's global data structures.

To use the Function with separate data parameter,

• Configure the model with an ERT-based system target file.
• Configure the subsystem to be atomic or conditionally executed.
• Set the subsystem block parameter Function packaging to Nonreusable function.

To configure your subsystem for generating modular function code, invoke the Subsystem Parameters
dialog box and make a series of selections to display and enable the Function with separate data
option. See “Configure Subsystem for Generating Modular Function Code” on page 41-2 and
“Modular Function Code for Nonvirtual Subsystems” on page 41-5 for details. For limitations that
apply, see “Nonvirtual Subsystem Modular Function Code Limitations” on page 41-17.

For more information about generating code for atomic subsystems, see the sections “Control
Generation of Functions for Subsystems” and “Generate Code and Executables for Individual
Subsystems”.

Configure Subsystem for Generating Modular Function Code
1 Verify that the model containing the subsystem uses an ERT-based system target file.
2 Select the subsystem for which you want to generate modular function code and open the

Subsystem Parameters dialog box. The dialog box for an atomic subsystem is shown below. (In
the dialog box for a conditionally executed subsystem, the dialog box option Treat as atomic
unit is greyed out, and you can skip Step 3.)
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3 If the block parameter Treat as atomic unit is available for selection but not selected, the
subsystem is neither atomic nor conditionally executed. Select the parameter Treat as atomic
unit, which enables the Function packaging parameter on the Code Generation tab. Select
the Code Generation tab.

4 For the Function packaging parameter, select Nonreusable function. After you make this
selection, the Function with separate data parameter is displayed.
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Before you generate code for the nonvirtual subsystem with the Function with separate
dataparameter selected, consider generating function code with the parameter cleared and save
the generated function .c and .h files in a separate directory for later comparison.

5 Select the Function with separate data parameter. Additional parameters appear.
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To control the naming of the generated subsystem function and the subsystem files, modify
subsystem parameters Function name options and File name options.

6 Save your subsystem parameter changes and exit the dialog box by clicking OK.
7 Generate code for the subsystem and examine the generated files, including the function .c

and .h files named according to your subsystem parameter specifications.

For more information on generating code for nonvirtual subsystems, see “Control Generation of
Functions for Subsystems”. For examples of generated subsystem function code, see “Modular
Function Code for Nonvirtual Subsystems” on page 41-5.

Modular Function Code for Nonvirtual Subsystems
This example shows how to generate nonvirtual subsystem function code with the Function with
separate data parameter cleared and selected and compares the results.

1 Open example model rtwdemo_atomic. Then, open the Embedded Coder app. Change the
system target file to ert.tlc.

This model shows how to preserve the boundary of a virtual subsystem. When you select
subsystem block parameter Treat as atomic unit, the code that the code generator produces for
the subsystem executes as an atomic unit. When configured as atomic, you can specify how the
code generator represents the subsystem by setting the Function Packaging parameter on the
Code Generation tab. You can specify that the subsystem is translated to one of these types of
implementation:

• Inline: Inlined subsystem code at call sites.
• Function: void/void function with I/O and internal data in the model global data structure.
• Reusable Function: Reentrant function with data passed in as function arguments.
• Auto: Code generator optimizes the implementation based on context.

2 Double-click the SS1 subsystem and examine the contents.

Then, close the subsystem window.
3 Right-click the SS1 subsystem, select Block Parameters (Subsystem) from the context menu, and

examine the settings. Simulink and the code generator can avoid "artificial" algebraic loops when
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you make the subsystem atomic with subsystem parameter Minimize algebraic loop
occurrences.

4 Create a variant of rtwdemo_atomic that shows function code without data separation.

a In the Subsystem Parameters dialog box,

• In the Main tab, select Treat as atomic unit.
• In the Code Generation tab:

• Set Function packaging to Nonreusable function.
• Set Function name options to User specified.
• Set Function name to myfun.
• Set File name options to Use function name. This setting is optional but
simplifies the later task of code comparison by causing the atomic subsystem function
code to be generated into files myfun.c and myfun.h.

Do not select the Function with separate data parameter.
b Click Apply to apply the changes and click OK to exit the dialog box.
c Save the model variant with a unique file name (for example, rtwdemo_atomic1) to a

writable location.
5 Create a variant of rtwdemo_atomic that shows function code with data separation.

a Open model rtwdemo_atomic.
b Open the Embedded Coder app. Change the system target file to ert.tlc.
c In the model canvas, right-click the SS1 subsystem and select Block Parameters

(Subsystem). In the Subsystem Parameters dialog box,

• In the Main tab, select Treat as atomic unit.
• In the Code Generation tab:

• Set Function packaging to Nonreusable function.
• Set Function name options to User specified.
• Set Function name to myfun.
• Set File name options to Use function name.
• Select Function with separate data.

d Click Apply to apply the change and click OK to exit the dialog box.
e Save the model variant with a unique file name (for example, rtwdemo_atomic2) to a

writable location.
6 Generate code for each model (for example, rtwdemo_atomic1 and rtwdemo_atomic2).
7 Compare the model.c/.h and myfun.c/.h files generated for the two models. For code

comparison discussion, see “H File Differences for Nonvirtual Subsystem Function Data
Separation” on page 41-7 and “C File Differences for Nonvirtual Subsystem Function Data
Separation” on page 41-7.

In this example, there are not significant differences in the generated variants of ert_main.c,
model_private.h, model_types.h, or rtwtypes.h.
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H File Differences for Nonvirtual Subsystem Function Data Separation

• Selecting Function with separate data causes the code generator to place type definitions for
subsystem data in the myfun.h file for rtwdemo_atomic2:

/* Block states (default storage) for system '<Root>/SS1' */
typedef struct {
  real_T Integrator_DSTATE;            /* '<S1>/Integrator' */
} DW_myfun_T;

For rtwdemo_atomic1, type definitions for subsystem data belong to the model and appear in
rtwdemo_atomic1.h:

/* Block signals (default storage) */
typedef struct {
  real_T Sum;                          /* '<Root>/Sum' */
} B_rtwdemo_atomic_1_T;

/* Block states (default storage) for system '<Root>' */
typedef struct {
  real_T Integrator_DSTATE;            /* '<S1>/Integrator' */
} DW_rtwdemo_atomic_1_T;

• Selecting Function with separate data generates the following external declarations in the
myfun.h file for rtwdemo_atomic2:
/* Extern declarations of internal data for system '<Root>/SS1' */
extern DW_myfun_T myfun_DW;
extern void myfun_Update(void);
extern void myfun(void);

By contrast, the generated code for rtwdemo_atomic1 contains model-level external declarations
for the subsystem BlockIO and D_Work data, in rtwdemo_atomic1.h:

/* Block signals (default storage) */
extern B_rtwdemo_atomic_1_T rtwdemo_atomic_1_B;

/* Block states (default storage) */
extern DW_rtwdemo_atomic_1_T rtwdemo_atomic_1_DW;

C File Differences for Nonvirtual Subsystem Function Data Separation

• Selecting Function with separate data causes a separate subsystem initialize function,
myfun_initialize, to be generated in the myfun.c file for rtwdemo_atomic2:

void myfun_initialize(void) {
  {
    ((real_T*)&rtwdemo_atomic2_myfunB.Integrator)[0] = 0.0;
  }
  rtwdemo_atomic2_myfunDW.Integrator_DSTATE = 0.0;
}

The subsystem initialize function in myfun.c is invoked by the model initialize function in
rtwdemo_atomic2.c:

/* Model initialize function */

void rtwdemo_atomic2_initialize(void)
{
...
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  /* Initialize subsystem data */
  myfun_initialize();
}

By contrast, for rtwdemo_atomic1, subsystem data is initialized by the model initialize function
in rtwdemo_atomic1.c:

/* Model initialize function */

void rtwdemo_atomic1_initialize(void)
{
...
  /* block I/O */
  {
 ...
    ((real_T*)&rtwdemo_atomic1_B.Integrator)[0] = 0.0;
  }

  /* states (dwork) */

  rtwdemo_atomic1_DWork.Integrator_DSTATE = 0.0;
...
}

• Selecting Function with separate data generates the following declarations in the myfun.c file
for rtwdemo_atomic2:

/* Declare variables for internal data of system '<Root>/SS1' */
DW_myfun_T myfun_DW;

By contrast, the generated code for rtwdemo_atomic1 contains model-level declarations for the
subsystems BlockIO and D_Work data, in rtwdemo_atomic1.c:

/* Block signals (default storage) */
B_rtwdemo_atomic_1_T rtwdemo_atomic_1_B;

/* Block states (default storage) */
DW_rtwdemo_atomic_1_T rtwdemo_atomic_1_DW;

• Selecting Function with separate data generates identifier naming that reflects the subsystem
orientation of data items. The references to subsystem data in subsystem functions, such as myfun
and myfun_update, are in the model model_step function. For example, compare this code from
myfun for rtwdemo_atomic2
/*  DiscreteIntegrator: '<S1>/Integrator' */
  rtwdemo_atomic_2_Y.Out1 = myfun_DW.Integrator_DSTATE;

to the corresponding code from myfun for rtwdemo_atomic1.
/* DiscreteIntegrator: '<S1>/Integrator' */
rtwdemo_atomic_1_Y.Out1 = rtwdemo_atomic_1_DW.Integrator_DSTATE;

Partition Functions in Generated Code
This example shows how to associate subsystems in a model with function names and files.

Learn how to:
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• Specify function and file names in the generated code.
• Identify the parts of the generated code that are required for integration.
• Generate code for atomic subsystems.
• Identify data that are required to execute a generated function.

For information about the example model and other examples in this series, see “Prepare a Control
Algorithm Model for C Code Generation” on page 51-18.

Atomic and Virtual Subsystems

The example models in “Prepare a Control Algorithm Model for C Code Generation” on page 51-18
and “Configure Data Interface in the Generated Code” on page 51-29 use virtual subsystems. Virtual
subsystems visually organize blocks but do not affect the model functionality. Atomic subsystems
evaluate the blocks included in a model as a unit. With atomic subsystems, you can specify additional
function partitioning information. In a model, atomic subsystems appear with a bold border.

View Changes in Model Architecture

Open the example model rtwdemo_PCG_Eval_P3.

Save a copy of the model to a writable folder.

This example shows how to replace the virtual subsystems with function-call subsystems. Function-
call subsystems:

• Are atomic subsystems
• Enable you to control subsystem execution order
• Execute when a function call signal triggers

By controlling the execution order of the subsystems, you can match the model with an existing
system that has a specific execution order.

The figure identifies the function call subsystems (1) PI_ctrl_1, PI_ctrl_2, and
Pos_Command_Arbitration.
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This version of the model contains the new subsystem Execution_Order_Control (2), which
contains a Stateflow® chart that models the calling functionality of a scheduler. The subsystem
controls the execution order of the function call subsystems through function call signals (3). Later in
this example, you examine how changing the execution order can change the simulation results.

This version of the model contains new Signal Conversion blocks (4) at the outputs of the PI
controllers. With these additional blocks in place, the code generator can generate a single reentrant
function for the PI controllers.

Control Function Location and File Placement in the Generated Code

In “Prepare a Control Algorithm Model for C Code Generation” on page 51-18 and “Configure Data
Interface in the Generated Code” on page 51-29, the code generator creates a single model_step
function that contains the control algorithm code. However, many applications require a greater level
of control over the file placement of functions. By modifying the parameters of atomic subsystems,
you can specify multiple functions within a single model.

The figure shows the subsystem parameters for PI_ctrl_1.
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Treat as atomic unit

• Enables other submenus. For atomic subsystems, this parameter is automatically selected and
disabled.

Sample time

• Specifies a sample time for execution. Not available for function-call subsystems.

Function packaging options

• Auto -- Determines how the subsystem appears in the generated code. This value is the default.
• Inline -- Places the subsystem code inline with the rest of the model code.
• Function -- Generates the code for the subsystem as a function.
• Reusable function -- Generates a reusable (reentrant) function from the subsystem. The

function passes all input and output data through formal parameters. The function does not
directly access global variables.

Function name options

• Selecting Function or Reusable function for Function packaging enables function name
options.

• Auto -- Determines the function.
• Use subsystem name -- Bases the function on the subsystem name.
• User specified -- Applies the specified file name.

File name options

• Selecting Function or Reusable function for Function packaging enables file name options.
• Auto -- Places the function definition in the module generated for the parent system, or, if the

model root is the parent, in model.c.
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• Use subsystem name -- Generates a separate file. The name of the file is the name of the
subsystem or library block.

• Use function name -- Generates a separate file. The name of the file is the name that you
specify with Function name options.

• User specified -- Applies the specified, unique file name.

Function with separate data

• Enabled when you set Function packaging to Function. When selected, the code generator
separates the internal data of the subsystem (for example, signals) from the data of the parent
model. The subsystem owns this separate data.

Generate Reentrant Code

Embedded Coder® supports reentrant code. Reentrant code is a reusable programming routine that
multiple programs can use simultaneously. Reentrant code is used in operating systems and other
system software that uses multithreading to handle concurrent events. Reentrant code does not
maintain state data, so there are no persistent variables in the function. Calling programs maintain
state variables and must pass the state data into the function. Multiple users or processes can share
one copy of a reentrant function.

To generate reentrant code, you must first specify the subsystem as reusable by configuring the
subsystem parameter Function packaging.

In some cases, the configuration of the model prevents reusable code. The table lists common issues.

Cause                                     Solution
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Subsystem output feeds global signal      Add a Signal Conversion block between the 
data                                      subsystem and the global signal.

Generated function receives data          Select Configuration Parameters >
(formal parameters) through pointers      Model Referencing > Pass fixed-size scalar root
                                          inputs by value for code generation.           

Subsystem uses global signal data         Use a port to pass the global data in and out 
in internal algorithm                     of the subsystem.

Use a Mask to Pass Parameter Values into Library Subsystem

To define algorithmic parameter data (such as a gain or coefficient) outside the scope of a reusable
library block or subsystem, you can apply a mask to the block or subsystem and create a mask
parameter. You can then specify a different parameter value for each instance of the block or
subsystem. Each mask parameter appears in the generated code as a formal parameter of the
reentrant function.

In this version of the model, the subsystems PI_ctrl_1 and PI_ctrl_2 are masked. In each mask,
the values of the P and I gains are set by data objects such as I_Gain_2 and P_Gain_2.

Generate Code for Atomic Subsystem

In “Prepare a Control Algorithm Model for C Code Generation” on page 51-18 and “Configure Data
Interface in the Generated Code” on page 51-29, you generate code at the root level of the model.
Alternatively, you can build a specific subsystem.
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To initiate a subsystem build, use the context menu. You can choose from these options:

1 Build This Subsystem: Treats the subsystem as a separate mode and creates the full set of
source C files and header files. This option does not support function-call subsystems.

2 Generate S-Function: Generates C code for the subsystem and creates an S-Function wrapper.
You can then simulate the code in the original model. This option does not support function-call
subsystems.
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3 Export Functions: Generates C code without the scheduling code that comes with the Build
This Subsystem option. Use this option to build subsystems that use triggers, such as function-
call subsystems.

Alternatively, open the Embedded Coder app, select the subsystem and on the C Code tab, click
Build.

Examine Generated Code

This example compares the files that are generated for the full system build with the files that are
generated for exported functions. You also examine how the masked data appears in the code.

Run the build script for the three options. Then, examine the generated files by clicking the
hyperlinks.

1 Generate code from the entire model.
2 Export the function PI_ctrl_1.
3 Export the function Pos_Command_Arbitration.

rtwdemo_PCG_Eval_P3.c

• Full Build: Yes, Step function
• PI_ctrl_1: No
• Pos_Command_Arbitration: No

PI_ctrl_1.c

• Full Build: No
• PI_ctrl_1: Yes, Trigger function
• Pos_Command_Arbitration: No

Pos_Command_Arbitration.c

• Full Build: No
• PI_ctrl_1: No
• Pos_Command_Arbitration: Yes, Init and Function

PI_Ctrl_Reusable.c

• Full Build: Yes
• PI_ctrl_1: Yes
• Pos_Command_Arbitration: No

ert_main.c

• Full Build: Yes
• PI_ctrl_1: Yes
• Pos_Command_Arbitration: Yes

eval_data.c
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• Full Build: Yes(1)
• PI_ctrl_1: Yes(1)
• Pos_Command_Arbitration: No, Eval data not used in diagram

(1) eval_data.c has different content in the full and export function builds. The full build includes
all of the parameters that the model uses. The export function contains only the variables that the
subsystem uses.

Masked Data in the Generated Code

In the file rtwdemo_PCG_Eval_P3.c, the call sites of the reentrant function use the data objects
P_Gain, I_Gain, P_Gain_2, and I_Gain_2 as arguments.

Effect of Execution Order on Simulation Results

By default, Simulink® executes the subsystems in this order:

1 PI_ctrl_1
2 PI_ctrl_2
3 Pos_Command_Arbitration

For this example, you can specify one of two alternative orders of execution. You can then use the test
harness to observe the effect of the execution order on the simulation results. The subsystem
Execution_Order_Control has two configurations that control the execution order. To choose a
configuration, use the subsystem context menu.

Change the execution order and observe the results.

1 Set the execution order to PI_ctrl_1, PI_ctrl_2, Pos_Command_Arbitration.
2 Open the test harness.
3 Run the test harness.
4 Change the execution order to Pos_Command_Arbitration, PI_ctrl_1, PI_ctrl_2.
5 Run the test harness.

The simulation results (throttle position over time) vary slightly depending on the order of execution.
You can see the difference most clearly when the throttle request changes.
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For the next example in this series, see “Call External C Code from Model and Generated Code” on
page 51-47.

Nonvirtual Subsystem Modular Function Code Limitations
Nonvirtual subsystem block parameter Function with separate data has the following limitations:

• The parameter is available for models configured with an ERT-based system target file.
• The nonvirtual subsystem to which the parameter is applied cannot have multiple sample times or

continuous sample times; that is, the subsystem must be single-rate with a discrete sample time.
• The nonvirtual subsystem cannot contain continuous states.
• The nonvirtual subsystem cannot output function call signals.
• The nonvirtual subsystem cannot contain noninlined S-functions.
• The generated files for the nonvirtual subsystem will reference model-wide header files, such as

model.h and model_private.h.
• The parameter is incompatible with the Classic call interface parameter. Selecting both

parameters generates an error.
• The parameter is incompatible with the Reusable function setting for model configuration

parameter Code interface packaging. Selecting both parameters generates an error.

• When you select the parameter for a subsystem, the model that contains the subsystem cannot
contain a Data Store Memory block with Share across model instances selected. See Data Store
Memory.
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See Also

More About
• “Design Models for Generated Embedded Code Deployment” on page 1-2
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Generate Reentrant, Multi-Instance Code
This example shows you how to configure a model for reentrant, multi-instance code generation.
Multiple programs can use reentrant code simultaneously. When you configure a model for
reentrancy, the execution (step) entry-point function uses root-level input and output arguments
instead of global data structures. After examining the configuration settings, generate and review the
generated code.

Open the Model

Open the model rtwdemo_reusable. The model contains two root Inport blocks and a root Outport
block.

model='rtwdemo_reusable';
open_system(model);

Save a copy of the model to a writable location.

currentDir=pwd;
[~,cgDir] = rtwdemodir();

Examine Relevant Model Configuration Parameter Settings

1. Open the Embedded Coder app.

2. Open the Model Configuration Parameters dialog box.

3. Model configuration parameter System target file is set to ert.tlc. Although you can generate
reentrant code for a model configured with System target file set to grt.tlc, ERT and ERT-based
system target files provide more control over how the code passes root-level I/O.

4. Open the Code Generation > Interface pane and explore relevant model configuration
parameter settings.

• Code interface packaging is set to Reusable function. This parameter setting instructs the
code generator to produce reusable, multi-instance code.

• Setting of Reusable function displays parameter Multi-instance code error diagnostic.
That parameter is set to Error, indicating that the code generator abort if the model violates
requirements for generating multi-instance code.
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• Pass root-level I/O as is set to Part of model data structure. This setting packages root-
level model input and output into the real-time model data structure (rtModel), which is an
optimized data structure that replaces SimStruct as the top-level data structure for a model.

• Remove error status field in real-time model data structure is selected. This parameter
setting reduces memory usage by omitting the error status field from the generated real-time
model data structure.

Generate and Review Code

slbuild(model);

### Starting build procedure for: rtwdemo_reusable
### Successful completion of build procedure for: rtwdemo_reusable

Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
rtwdemo_reusable  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.048s

Review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code
controls model code execution by calling the entry-point function rtwdemo_reusable_step. Use
this file as a starting point for coding your execution framework.

• rtwdemo_reusable.c contains entry points for the code that implements the model algorithm.
This file includes the rate scheduling code.

• rtwdemo_reusable.h declare model data structures and a public interface to the model entry
points and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Code Interface

Open and review the Code Interface Report. Use the information in that report to write the interface
code for your execution framework.

1. Include the generated header file by adding directive #include rtwdemo_reusable.h.

2. Write input data to the generated code for model Inport blocks.

3. Call the generated entry-point functions.

4. Read data from the generated code for the model Outport block.

Input ports:

• <Root>/In1 of data real_T with dimension of 1
• <Root>/In2 of data real_T with dimension of 1

Entry-point functions:
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• Initialization entry-point function, void rtwdemo_reusable_initialize(RT_MODEL *const
rtM). At startup, call this function once.

• Output and update (step) entry-point function, void rtwdemo_reusable_step(RT_MODEL
*const rtM). Call this function periodically at the fastest rate in the model. For this model, call
the function every second. To achieve real-time execution, attach this function to a timer.

Output port:

• <Root>/Out1 of data type real_T with dimension of 1

Examine the Step Function

Examine the |rtwdemo_reusable_step| function code in |rtwdemo_reusable.c|.

cfile = fullfile(cgDir,'rtwdemo_reusable_ert_rtw','rtwdemo_reusable.c');
rtwdemodbtype(cfile,'/* Model step function', '/* Model initialize function ', 1, 0);

/* Model step function */
void rtwdemo_reusable_step(RT_MODEL *const rtM)
{
  D_Work *rtDWork = rtM->dwork;
  ExternalInputs *rtU = (ExternalInputs *) rtM->inputs;
  ExternalOutputs *rtY = (ExternalOutputs *) rtM->outputs;

  /* Outport: '<Root>/Out1' incorporates:
   *  UnitDelay: '<Root>/Delay'
   */
  rtY->Out1 = rtDWork->Delay_DSTATE;

  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Sum: '<Root>/Sum'
   *  UnitDelay: '<Root>/Delay'
   */
  rtDWork->Delay_DSTATE = (rtU->In1 + rtU->In2) * rtP.k1;
}

The code generator passes model data to the rtwdemo_reusable_step function as part of the real-
time model data structure. Try different settings for model configuration parameters Code interface
packaging and Pass root-level I/O and regenerate code. Observe how the function prototype
changes.

Close the Model and Report

Close the model and the code generation report.
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bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also

Related Examples
• “Generate Reentrant Code from Top Models” on page 7-18
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Generate Code for String Blocks by using the Standard C++
String Library

Optimize generated code for Simulink string blocks by using standard C++ library string functions
and string objects. The C++ string library provides consistent C++ code and improves functionality,
such as string length retrieval, concatenation, string copy, string swapping, string comparison, and
substring computations.

Example Model

In the model matlab:mStrfindSubStr, a string constant block that has the value "Hello!" connects to
the str port of a String Find block. An inport connects to the sub port of the same String Find block.

model = 'mStrfindSubStr';
open_system(model);

In your system's temporary folder, create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Generate Code by using C++ String Libraries

In the Configuration Parameters dialog box, set the Language parameter to C++.

set_param(model, 'TargetLang', 'C++');

In the Configuration Parameters dialog box, set the Code interface packaging parameter to C++
class.

set_param(model, 'CodeInterfacePackaging', 'C++ class');

In the Configuration Parameters dialog box, set the Standard math library parameter to C++03
(ISO).

set_param(model, 'TargetLangStandard', 'C++03 (ISO)');

Build the model.

evalc('slbuild(model)');

View the generated code with C++ string library objects. Here is a portion of mStrfindSubStr.h.
The code instantiates a std:string object In1.

cfile = fullfile(cgDir,'mStrfindSubStr_ert_rtw','mStrfindSubStr.h');
rtwdemodbtype(cfile,'External inputs','External outputs',0,0);
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struct ExtU_mStrfindSubStr_T {
  std::string In1;                     // '<Root>/In1'
};

View the generated code with C++ string library functions. Here is a portion of
mStrfindSubStr.cpp. The code uses the find function to look for the first character match, which
is present in the C++ string library.

cfile = fullfile(cgDir,'mStrfindSubStr_ert_rtw','mStrfindSubStr.cpp');
rtwdemodbtype(cfile,'Model step function','Model initialize function',0,0);

void untitled1ModelClass::step()
{
  uint32_T tmpOut;

  // StringFind: '<Root>/String Find' incorporates:
  //   Inport: '<Root>/In1'
  //   StringConstant: '<Root>/String Constant'

  tmpOut = mStrfindSubStr_P.StringConstant_String.find(mStrfindSubStr_U.In1);
  if (tmpOut == (uint32_T)std::string::npos) {
    // Outport: '<Root>/Out1'
    mStrfindSubStr_Y.Out1 = -1;
  } else {
    // Outport: '<Root>/Out1'
    mStrfindSubStr_Y.Out1 = static_cast<int32_T>(tmpOut) + 1;
  }

  // End of StringFind: '<Root>/String Find'
}

This code executes faster and is easier to read. Close the model and the code generation report.

bdclose(model);
rtwdemoclean;
cd(currentDir);

Limitations:

An array of a bus that contains std:string is not supported in software-in-loop (SIL) and processor-in-
loop (PIL) simulations.

See Also

More About
• “Document Generated Code with Simulink Report Generator” on page 52-36
• “Use dynamic memory allocation for model initialization”
• “Use dynamic memory allocation for model block instantiation”
• “Remove root level I/O zero initialization”
• “Remove internal data zero initialization”
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Configure C++ Class Interface

• “Interactively Configure C++ Interface” on page 42-2
• “Programmatically Configure C++ Interface” on page 42-25
• “Configure C++ Class Interface for Rate-Based Models” on page 42-44
• “Configure C++ Class Interface for Export-Function Models” on page 42-48
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Interactively Configure C++ Interface
To streamline the integration of C++ code generated from Simulink applications, components, and
subsystems with external C or C++ code, configure a customized C++ class interface. When you
generate C++ code from a model, the model appears as a class, the data elements appear as class
members, and the model functions appear as class methods in the generated code. Configuring a C+
+ class interface enables you to customize the following aspects of the generated C++ code:

• Class information — Class name and namespace
• Class member information — Class member access and visibility
• Class method information — Class method names and arguments

A customized C++ class interface enables the generated classes to meet specific code standards or
interface requirements so that the generated code can compile and integrate into larger
architectures with minimal post-generation customization.

Interactive Workflow Overview
The interactive workflow provides quick, intuitive, and complete configuration of a customized C++
class interface by using tools accessible directly from the C++ Code tab. From the tab, you can click
Code Interface and access the Class Name & Namespace configuration dialog box and Code
Mappings editor (with Property Inspector) to configure an interface.

To interactively configure a customized C++ interface:

1 “Open Environment” on page 42-2
2 “Configure Model as Class” on page 42-4
3 “Configure Model Data Elements as Class Members” on page 42-5
4 “Configure Model Functions as Class Methods” on page 42-14
5 “Generate C++ Class Interface” on page 42-22

Open Environment
Open the environment for configuring a customized C++ class interface:

1 Open the Embedded Coder app. In the Apps gallery, click Embedded Coder.
2 Set the language to C++. On the C++ Code tab, click Output and select Embedded C++

Code.
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3 Set the model configuration parameters. To open the Configuration Parameters dialog box, on the
C++ Code tab, click Settings, and select C/C++ Code generation settings. These parameters
configure model-wide code generation behavior. To configure parameters specific to generating a
customized C++ class interface, you can set these parameters (located on the Interface pane):

Configuration Parameter Description
Code interface packaging Selects output language for generated code.

For more information, see “Code interface
packaging”.

Multi-instance code error diagnostic Specifies the severity level for diagnostics
displayed when a model violates
requirements for generating multi-instance
code. For more information, see “Multi-
instance code error diagnostic”.
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Configuration Parameter Description
Remove error status field in real-time
model data structure

Specifies whether to omit the error status
field from the generated real-time model data
structure rtModel. For more information,
see “Remove error status field in real-time
model data structure”.

Include model types in model class Specifies to include model type definitions
within the class namespace of the model. For
more information, see “Include model types
in model class”.

Interface parameters that are related but are less commonly used appear under Advanced
parameters.

Configuration Parameter Description
Terminate function required Specifies whether to generate the

model_terminate method. For more
information, see “Terminate function
required”.

Combine signal/state structures Specifies whether to combine global block
signals and global state data into one data
structure in the generated code. For more
information, see “Combine signal/state
structures”.

Generate destructor Specifies whether to generate a destructor
for the C++ model class. For more
information, see “Generate destructor”.

Use dynamic memory allocation for
model block instantiation

Specifies memory allocation for model
hierarchies. For more information, see“Use
dynamic memory allocation for model block
instantiation”.

Configure Model as Class
Configure the class name and namespace. When you generate C++ code from a model, that model
appears as a class in the generated code. To ease integration and comply with code and interface
requirements, you can customize the generated class name. Optionally, you can scope the generated
code and prevent symbol clashes within a project by specifying a namespace for the generated class.
In modeled systems constructed as a model hierarchy, you can specify a different namespace for each
model in the hierarchy.

The generated C++ class interface, declared in the model header file, incorporates the customized
name and namespace:

// File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
    // public data and function members
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   public:

    // private data and function members     
   private:

  };
}

Workflow

To configure the class name and namespace for a customized C++ class interface:

1 On the C++ Code tab, click Code Interface and select Class Name & Namespace.

2 To configure the class name, edit the C++ Class Name field.
3 To configure the class namespace, edit the C++ Class Namespace field.
4 Click OK. Validation is performed interactively with field warnings that alert you if you enter an

invalid name or namespace.

Configure Model Data Elements as Class Members
Configure the visibility and access of class members. When you generate C++ code from a model,
Simulink data elements appear as class members in the generated code. To adjust the encapsulation
of the class data to meet code standards, security, or performance requirements, you can customize
the visibility and access of the generated class members. Simulink data elements can be grouped into
these categories of modeling elements:

Model Element Category Description
Inports Root-level data input ports of a model, such as Inport and In Bus

Element blocks. For more information, see Inport.
Outports Root-level data output ports of a model, such as Outport and Out

Bus Element blocks. For more information, see Outport.
Model parameter arguments Workspace variables that appear as instance (nonstatic) class data

members.
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Model Element Category Description
Model parameters Workspace variables that are shared across instances of the model

class that are generated as static class data members.
Signals, states, and internal
data

Data elements that are internal to a model, such as block output
signals, discrete block states, data stores, and zero-crossing
signals.

For each model element category, you can configure the data visibility to control the access modifier
(access specifier) of the generated class members. Each option and its impact on the generated C++
class interface, declared in the model header file, is outlined:

Data Visibility Options Description
public If you configure data elements as public, they appear as public

members of the generated class:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
  
    // example inport
    ExtU rtU;

    // example outport
    ExtY rtY;
  
    // example block signals and states
    DW rtDW;
     
   private:
    … 
  };
}
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Data Visibility Options Description
protected If you configure data elements as protected, they appear as

protected members of the generated class:

File: rtwdemo_cpp_workflow.h

// Class declaration for model example_model
namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:

   protected:

    // example inport
    ExtU rtU;

    // example outport
    ExtY rtY;
  
    // example block signals and states
    DW rtDW;   

   private:
    … 
  };
}

private If you configure elements as private, they appear as private
members of the generated class:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
    
   private:
    // example inport
    ExtU rtU;

    // example outport
    ExtY rtY;
  
    // example block signals and states
    DW rtDW;
  };
}
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Data Visibility Options Description
Individual arguments (Model
parameter arguments only)

If you configure data elements as Individual arguments, the
elements do not appear as members of the class, but are instead
defined outside the class and passed as arguments to class
methods:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:

   // model step function
   void step1(real_T rty_engineState,
     const real_T modelParameterArgument);
    
   private:
    … 
  };
}

After you set the data visibility of a model element category, you can configure the model access
method to determine how the get and set methods are generated for the data elements. This
configuration controls how application code can view and modify the class member data. Each option
and its impact on the generated C++ class interface, declared in the model header file, is outlined:
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Member Access Method
Options

Description

Method If you configure inports as Method, a set method appears for each
inport. If you configure outports as Method, a get method appears
for each outport in the model. If you configure the other model
element categories as Method, an aggregate structure-based get
and set method appears for the data element category.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // example inport
   void setInport(real_T localArgInput);

   // example outport
   real_T getOutport() const;

   // example of model parameter arguments configured with
   // ‘DataAccess’ ‘Direct'
   real_T const & getInstP() const;

   // example of model parameter arguments configured with
   // ‘DataAccess’ ‘Pointer’
   // real_T const * getInstP() const;

   // example Block parameters get and set methods
   const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_P &
     getBlockParameters() const;
 
   void setBlockParameters(const rtwdemo_cppclass_workflow_P
     *prtwdemo_cppclass_workflowrtrtP);

   // example Block states get and set methods
  const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_DW &
    getDWork() const;
 
  void setDWork(const rtwdemo_cppclass_workflow_DW
                *prtwdemo_cppclass_workflowrtDW);
    
   private:
    … 
  };
}
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Member Access Method
Options

Description

Inlined method If you configure inports as Inlined method, a set method
defined in its declaration appears for each inport. If you configure
outports as Inlined method, a get method defined in its
declaration appears for each outport in the model. If you configure
the other model element categories as Inlined method, an
aggregate structure-based get and set method defined in its
declaration appears for the data element category.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // example inport set method
   void setkeyState(real_T localArgInput)
   {
     rtU.keyState = localArgInput;
   }
 
   // example outport get method
   const real_T* getengineState() const
   {
     return rtY.engineState;
   }

   // example Block parameters get and set method
   const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_P &
     getBlockParameters() const
   {
     return rtwdemo_cppclass_workflowrtrtP;
   }
 
   void setBlockParameters(const rtwdemo_cppclass_workflow_P
     *prtwdemo_cppclass_workflowrtrtP)
   {
     rtwdemo_cppclass_workflowrtrtP = *prtwdemo_cppclass_workflowrtrtP;
   }

  // example Block states get and set methods
   const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_DW &
     getDWork() const
   {
     return rtwdemo_cppclass_workflowrtDW;
   }
 
   void setDWork(const rtwdemo_cppclass_workflow_DW
                 *prtwdemo_cppclass_workflowrtDW)
   {
     rtwdemo_cppclass_workflowrtDW = *prtwdemo_cppclass_workflowrtDW;
   }
     
   private:
    … 
  };
}
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Member Access Method
Options

Description

Structure-based method If you configure the inports as Structure-based method, the
inports appear as an aggregate structure-based set method for the
model element category. If you configure the outports as
Structure-based method, the outports appear as aggregate
structure-based get method for the model element category. This
configuration option does not apply to the other model element
categories.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
    // public data and function members
   public:
   // example inport
   void setExternalInputs(const ExtU_demoMethodScheduledModel_T 
      * pExtU_demoMethodScheduledModel_T);
 
   // example outport 
   const myNamespace::myModelClass::ExtY_demoMethodScheduledModel_T
      & getExternalOutputs() const;

    // Other model element categories may not be configured as ‘Structure-based method’
        
   private:
    … 
  };
}

Inlined structure-based method If you configure the inports as Structure-based method, the
inports appear as aggregate structure-based set method defined in
its declaration for the model element category. If you configure the
outports to Structure-based method, the outports appear as
aggregate structure-based get method defined in their declaration
for the model element category. This configuration option does not
apply to the other model element categories.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // example inport
   void setExternalInputs(const ExtU_demoMethodScheduledModel_T
      * pExtU_demoMethodScheduledModel_T)
   {
      demoMethodScheduledModelWithR_U = *pExtU_demoMethodScheduledModel_T;
   }
 
    // example outport
   const myNamespace::myModelClass::ExtY_demoMethodScheduledModel_T
      & getExternalOutputs() const
   {
      return demoMethodScheduledModelWithR_Y;
   }
   // Other model element categories may not be configured as ‘Inlined structure-based method’
    
   private:
    … 
  };
}
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Member Access Method
Options

Description

None If you configure the access of a model element category as None,
get and set methods do not appear in the generated class and data
can be accessed directly by application code.

File: rtwdemo_cpp_workflow.h

  // External inputs (root inport signals with default storage)
  struct ExtU {
    real_T keyState;                   // '<Root>/keyState'
  };
 
  // External outputs (root outports fed by signals with default storage)
  struct ExtY {
    real_T engineState[3];             // '<Root>/engineState'
    real_T cycleTime;                  // '<Root>/cycleTime'
  };

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // External inputs
   ExtU rtU;
 
   // External outputs
   ExtY rtY;
        
   private:
    … 
  };
}

For each model element category, valid data visibility and member access method combinations are
outlined:

Model Element Category Data Visibility Member Access Method
Inports private Method

Inlined method

Structure-based method

Inlined structure-based method
public None

Method

Inlined method

Structure-based method

Inlined structure-based method
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Model Element Category Data Visibility Member Access Method
Outports private Method

Inlined method

Structure-based method

Inlined structure-based method
public None

Method

Inlined method

Structure-based method

Inlined structure-based method
Model parameter arguments Individual arguments None

private Method

Inlined method
Model parameters private None

Method

Inlined method
public None

Method

Inlined method
Signals, states, and internal
data

private None

Method

Inlined method
public None

Method

Inlined method

Workflow

To configure the class members of a customized C++ class interface:

1 Open the Code Mappings editor. On the C++ Code tab, click Code Interface and select Code
Mappings.

2 Open the Data pane. In the Code Mappings editor, click the Data tab.
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3 Configure the visibility. To configure the visibility of a category of Simulink data elements in the
generated code, from the Data Visibility column, select an access specifier from the given
options. Options vary depending on the Model Element Category.

4 Configure the access. To configure the access of a category of Simulink data elements in the
generated code, from the Member Access Method column, select how to generate get and set
methods from the given options. Options vary depending on the Model Element Category and
the selected Data Visibility.

Configure Model Functions as Class Methods
Configure the class method names and arguments. When you generate C++ code from a model,
model functions appear as class methods in the generated code. To integrate with external code or
interface requirements, you can customize the name of the generated class methods. Additionally, for
base-rate periodic functions and Simulink Functions, you can configure the name, order, and
identifier of the generated arguments.

The generated class methods are referred to as entry-point methods and are locations in code where
a transfer of program control (execution) occurs. Entry-point methods vary depending on the type of
Simulink model and can be grouped into the following types:
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Model Type Type of Model
Function

Description Name of Model
Function

Expected Method
Name

Export-Function
Models

Exported function The exported
function for a
subsystem.

ExportedFuncti
on:slIdentifie
r, where
slIdentifier is
the name of the
function-call Inport
block in the model

function-call-
inport-block-
name or signal-
label (if
specified)

Simulink Function The exported
function for a
Simulink Function
block.

Simulink
Function:slIde
ntifier, where
slIdentifier is
the name of the
Simulink Function
block in the model

function-name
for a global
Simulink Function
block or
model_function
-name for a scoped
Simulink Function
block

Export-Function or
Rate-based Models

Initialize function Initialization code
for a model. At the
start of the
application code,
call the function
once. Do not use
this function to
reset the real-time
model data
structure (rtM).

Initialize model_initiali
ze

Partition function For a model
partition, output
and update code.
Model
configuration
parameter Single
output/update
function is
selected (the
default).

Partition:slId
entifier, where
slIdentifier is
a partition that
was created
explicitly from a
block in the model
and shown in the
Simulink®
Schedule Editor
(for example, P1)

model_stepn,
where n uniquely
identifies the
function generated
for one of the
model sample
periods
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Model Type Type of Model
Function

Description Name of Model
Function

Expected Method
Name

Periodic
multitasking
function

For blocks in a
rate-based model
configured for
multitasking,
output and update
code. The code
generator
produces a
function for each
sample period.
Model
configuration
parameter Single
output/update
function is
selected (the
default).

Periodic:slIde
ntifier, where
slIdentifier is
an annotation that
corresponds to the
sample time period
for a periodic or
continuous rate of
a multitasking
model (for
example, D1)

model_stepn,
where n uniquely
identifies the
function generated
for one of the
model sample
periods

Periodic single-
tasking function

For blocks in a
rate-based model
configured for
single-tasking,
output and update
code. Model
configuration
parameter Single
output/update
function is
selected (the
default).

Periodic model_step

Reset function If the model
includes a Reset
Function block,
reset code
generated. To reset
conditions or state,
call the function
from the
application code.

Reset:slIdenti
fier, where
slIdentifier is
the name of the
reset function in
the model

model_reset-
function-name
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Model Type Type of Model
Function

Description Name of Model
Function

Expected Method
Name

Terminate function Code for turning
off a system. For
ERT-based models,
you can suppress
generation of this
function by
clearing the model
configuration
parameter
Terminate
function
required (set by
default).

Terminate model_terminat
e

The generated C++ class interface, declared in the model header file, incorporates the function name
and argument customizations in the generated entry-point methods:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
    // model initialize function- customized name
   void customized_initialize();

    // model step function- customized name & arguments
   void customized_step(customArg1, const* customArg2);

    // model terminate function- customized name
   void customized_terminate();

    // Constructor
   customized_ModelClass();

    // Destructor
   ~customized_ModelClass();
 
   private:
  … 
  };
}

Workflow

1 Open the Code Mappings editor. On the C++ Code tab, click Code Interface and select Code
Mappings.

2 Open the Functions pane. In the Code Mappings editor, click the Functions tab. To view a
complete list of entry-point functions for your model, click the Update Diagram button.
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3 Configure method names.

a To configure the name of an entry-point method in the generated code, from the Method
Name column, click and directly edit the spreadsheet. You can enter a custom name or you
can use identifier format parameters to control a dynamically generated name. For more
information about identifier format parameters, see “Identifier Format Control” on page 53-
15.

b Verify the name in the Method Preview column.
4 Configure method arguments. For base-rate periodic functions and Simulink Functions, you can

configure the name, order, and identifiers of the method arguments.

To configure the arguments of a base-rate periodic function:

a Open the Step Function Interface configuration dialog box. From the Code Mappings editor,
on the Functions tab, in the Method Preview column, click the method preview hyperlink
of a base-rate periodic function:
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b In the dialog box, select Configure arguments for Step function prototype and click Get
default. This action launches a view of the method arguments.
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c To change the order of the arguments, click and drag the argument rows in the viewer.
d To change the identifier, in the C++ Type Qualifier column, select the appropriate identifier

from the drop-down list:

Identifier Option Preview
Value (Inports only) myPeriodicFunction(argInport)
Const Reference (Inports only) myPeriodicFunction(const & argInport)
Pointer to Const myPeriodicFunction(const * argInport)
Pointer myPeriodicFunction(* argInport)
Const Pointer to const myPeriodicFunction(const * const

argInport)
e To change the name of an argument, in the C++ Identifier Name column, click and directly

edit the name. You can enter a custom name or you can use identifier format parameters to
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control a dynamically generated name. For more information about identifier format
parameters, see “Identifier Format Control” on page 53-15.

i If you enter the same name for an inport argument and an outport argument the inport
and outport appear as one parameter in the generated method. For example, if you
specify an inport as argInport and an outport argument as argOutport, the
generated method would be:

myStepFunction(argInport, argOutport);

If you specify an inport argument as argIO and an outport argument as argIO, the
generated method would be:

myStepFunction(argIO);
f To verify the arguments selections, click Validate.
g To apply changes and exit the dialog box, click OK.

To configure the arguments of a Simulink Function:

a Open the Simulink Function Interface configuration dialog box. From the Code Mappings
editor, on the Functions tab, in the Method Preview column, click the method preview
hyperlink of a Simulink Function:

b To change the return argument, select a return argument option from the C/C++ return
argument drop-down list.

c To change the order of the arguments, click and drag the argument rows in the viewer.
d To change the identifier, in the C++ Type Qualifier column, select the identifier from the

drop-down list:
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Identifier Option Preview
Auto mySimulinkFunction(argInport)
Const Reference mySimulinkFunction(const & argInport)
Pointer to Const mySimulinkFunction(const * argInport)
Pointer mySimulinkFunction(* argInport)
Const Pointer to const mySimulinkFunction(const * const

argInport)
e To change the name of the argument, in the C++ Identifier name column, click and directly

edit the name. You can enter a custom name or you can use identifier format parameters to
control a dynamically generated name. For more information about identifier format
parameters, see “Identifier Format Control” on page 53-15.

f To verify changes to the Simulink Function arguments, review the Simulink function
prototype field to view the expected method prototype.

g To apply changes and exit the dialog box, click OK.

Generate C++ Class Interface
Generate the customized C++ class interface by generating code from the model. To verify your C++
class interface configurations, build the model and view the generated class, class member, and class
method representations.

1 Generate code. To generate a C++ class interface, on the C++ Code tab, click Build.
2 View code. To view the generated code, on the tab click View Code. The generated code appears

beside the model in the model workspace.
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3 Iterate. If the generated interface does not meet code requirements, make configuration
adjustments until requirements are satisfied.

If the generated code representation does not meet your requirements, reconfigure the interface and
generate code again until code generations requirements are satisfied. For guidance on
understanding the generated code, see “Analyze the Generated Code Interface” on page 52-13.

Considerations and Limitations
• Instance-Specific Parameter Support — You can use model parameter arguments to configure

workspace variables that have been specified as arguments. You can configure these arguments as
private members of your class or as individual arguments defined outside the class. To configure
within the class, you can set the data visibility to private and configure the generation of the get
and set methods. Optionally, you can configure the class member values as defined within the
class (in the Property Inspector, set Data Access to Direct) or passed-by-reference through the
class constructor (in the Property Inspector, set Data Access to Pointer). The data access
setting is supported for top model builds. For reference model builds, the code is generated as
references in the model class. To configure instance-specific parameters outside the class, set the
data visibility to individual arguments.

Instance-specific parameter limitations include:

• MATLAB variables marked as model arguments are not able to be configured as private class
members.
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• Model parameter arguments are not supported by right-click builds.
• Interface Code Generation Behavior — The I/O arguments style of step method specification

supports single-rate models and multirate single-tasking models. Multirate multitasking models
are not supported. Additionally, the C++ encapsulation interface is not the default, the value is
ignored for the Pass fixed-size scalar root inputs by value for code generation parameter.

• Stateflow considerations — If you have a Stateflow license, for a Stateflow chart that resides in a
root model configured to use the I/O arguments step method function specification, and that
uses a model root inport value or calls a subsystem that uses a model root inport value, do one of
the following to generate code:

• In the Stateflow chart, clear the Execute (enter) Chart At Initialization check box.
• Insert a Simulink Signal Conversion block immediately after the root inport. In the Signal

Conversion block parameters dialog box, select Exclude this block from 'Block reduction'
optimization.

• Simscape Considerations — If a model root inport value connects to a Simscape block, insert a
Simulink Signal Conversion block between the root inport and the Simscape conversion block. In
the Signal Conversion block parameters dialog box, select Exclude this block from 'Block
reduction' optimization.

• Referenced Model Considerations — When building a referenced model that is configured to
generate a C++ class interface:

• Do not use a C++ class interface in cases when a referenced model cannot have a combined
output/update function. Cases include a model that has a continuous sample time or saves
states.

• Do not use virtual buses as inputs or outputs to the referenced model when the referenced
model uses the I/O arguments step method. When bus signals cross referenced model
boundaries, either use nonvirtual buses or use the Default step method.

See Also

More About
• “Programmatically Configure C++ Interface” on page 42-25
• “Analyze the Generated Code Interface” on page 52-13
• “Identifier Format Control” on page 53-15
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Programmatically Configure C++ Interface
To streamline the integration of C++ code generated from Simulink applications, components, and
subsystems with external C or C++ code, configure a customized C++ class interface. When you
generate C++ code from a model, the model appears as a class, the data elements appear as class
members, and the model functions appear as class methods in the generated code. Configuring a C+
+ class interface enables you to customize the following aspects of the generated C++ code:

• Class information — Class name and namespace
• Class member information — Class member access and visibility
• Class method information — Class method names and arguments

A customized C++ class interface enables the generated classes to meet specific code standards or
interface requirements so that the generated code can compile and integrate into larger
architectures with minimal post-generation customization.

Programmatic Workflow Overview
The programmatic workflow uses a programmatic interface that you can call into by using the
MATLAB command line or a MATLAB script to configure a customized C++ class interface.
Additionally, you can use the functions to facilitate scripting, automated testing, and developing or
utilizing downstream features. The programmatic interface is composed of the following functions:

• To create or retrieve the Code Mappings object to configure a customized C++ Class interface,
you can use the functions coder.mapping.utils.create and coder.mapping.api.get.

• To configure the class name and namespace, you can use the functions getClassName,
setClassName, getClassNamespace, and setClassNamespace.

• To configure how data elements appear as class members, you can use the functions getData and
setData.

• To configure how model functions appear as class methods, you can use the functions find,
getFunction, and setFunction.

To programmatically configure a customized C++ interface, follow the outlined workflow:

1 “Open Environment” on page 42-25
2 “Configure Model as Class” on page 42-27
3 “Configure Model Data Elements as Class Members” on page 42-28
4 “Configure Model Functions as Class Methods” on page 42-36
5 “Generate C++ Class Interface” on page 42-41

Open Environment
Open the environment for configuring a customized C++ class interface:

1 Open the model and the MATLAB command prompt. Alternatively, you can create a MATLAB
configuration script.

model='rtwdemo_cpp_workflow'
open_system(model)
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2 Set model configuration parameters. These parameters configure model-wide code generation
behavior. To configure parameters specific to generating a customized C++ class interface, you
can use the set_param function to set these parameters:

Configuration Parameter Description
Code interface packaging Selects output language for generated code.

For more information, see “Code interface
packaging”.

Multi-instance code error diagnostic Specifies the severity level for diagnostics
displayed when a model violates
requirements for generating multi-instance
code. For more information, see “Multi-
instance code error diagnostic”.

Remove error status field in real-time
model data structure

Specifies whether to omit the error status
field from the generated real-time model data
structure rtModel. For more information,
see “Remove error status field in real-time
model data structure”.

Include model types in model class Specifies to include model type definitions
within the class namespace of the model. For
more information, see “Include model types
in model class”.

Interface parameters that are related, but are less commonly used:

Configuration Parameter Description
Terminate function required Specifies whether to generate the

model_terminate method. For more
information, see “Terminate function
required”.

Combine signal/state structures Specifies whether to combine global block
signals and global state data into one data
structure in the generated code. For more
information, see “Combine signal/state
structures”.

Generate destructor Specifies whether to generate a destructor
for the C++ model class. For more
information, see “Generate destructor”.

Use dynamic memory allocation for
model block instantiation

Specifies memory allocation for model
hierarchies. For more information, see“Use
dynamic memory allocation for model block
instantiation”.

3 To configure a customized C++ class interface for a model, create a Code Mappings object. To
create a new Code Mappings object for a model, use the function
coder.mapping.utils.create. If a Code Mappings object already exists for the model, the
function returns the existing object.

% Create a new Code Mappings object for a model 
cm = coder.mapping.utils.create(model);
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Configure Model as Class
Configure the class name and namespace. When you generate C++ code from a model, that model
appears as a class in the generated code. To ease integration and comply with code and interface
requirements, you can customize the generated class name. Optionally, you can scope the generated
code and prevent symbol clashes within a project by specifying a namespace for the generated class.
In modeled systems that use a model hierarchy, you can specify a different namespace for each model
in the hierarchy.

The generated C++ class interface, declared in the model header file, incorporates the customized
name and namespace:

// File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
    // public data and function members
   public:

    // private data and function members     
   private:

  };
}

Workflow

To programmatically configure the class name and namespace, get the Code Mappings object for your
model and set the name and namespace:

1 Get the Code Mappings object for your model. To get the object, use the function
coder.mapping.api.get.

% Get the Code Mappings object for a model 
cm = coder.mapping.api.get(model);

2 Configure the class name. To set the class name, use the function setClassName.

% Set the class name
setClassName(cm, 'customized_ModelClass');

To verify the new class name before generating code, use the function getClassName.

% Get the class name
getClassName(cm);

3 Configure the class namespace. To set the namespace, use the function setClassNamespace.

% Set the class namespace
setClassNamespace(cm, 'customized_namespace');

To verify the new namespace before generating code, use the function getClassNamespace.

% Get the class namespace
getClassNamespace(cm);

 Programmatically Configure C++ Interface

42-27



Configure Model Data Elements as Class Members
Configure the visibility and access of class members. When you generate C++ code from a model,
Simulink data elements appear as class members in the generated code. To adjust the encapsulation
of the class data to meet code standards, security, or performance requirements, you can customize
the visibility and access of the generated class members. Simulink data elements can be grouped into
the following categories of modeling elements:

Model Element Category Description
Inports Root-level data input ports of a model, such as Inport and In Bus

Element blocks. For more information, see Inport.
Outports Root-level data output ports of a model, such as Outport and Out

Bus Element blocks. For more information, see Outport.
Model parameter arguments Workspace variables that appear as instance (nonstatic) class data

members.
Model parameters Workspace variables that are shared across instances of the model

class that are generated as static class data members.
Signals, states, and internal
data

Data elements that are internal to a model, such as block output
signals, discrete block states, data stores, and zero-crossing
signals.

For each model element category, you can configure the data visibility to control the access modifier
(access specifier) of the generated class members. Each option and its impact on the generated C++
class interface, declared in the model header file, is outlined:

Data Visibility Options Description
public If you configure data elements as public, they appear as public

members of the generated class:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
  
    // example inport
    ExtU rtU;

    // example outport
    ExtY rtY;
  
    // example block signals and states
    DW rtDW;
     
   private:
    … 
  };
}
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Data Visibility Options Description
protected If you configure data elements as protected, they appear as

protected members of the generated class:

File: rtwdemo_cpp_workflow.h

// Class declaration for model example_model
namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:

   protected:

    // example inport
    ExtU rtU;

    // example outport
    ExtY rtY;
  
    // example block signals and states
    DW rtDW;   

   private:
    … 
  };
}

private If you configure elements as private, they appear as private
members of the generated class:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
    
   private:
    // example inport
    ExtU rtU;

    // example outport
    ExtY rtY;
  
    // example block signals and states
    DW rtDW;
  };
}
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Data Visibility Options Description
Individual arguments (Model
parameter arguments only)

If you configure data elements as Individual arguments, the
elements do not appear as members of the class, but are instead
defined outside the class and passed as arguments to class
methods:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:

   // model step function
   void step1(real_T rty_engineState,
     const real_T modelParameterArgument);
    
   private:
    … 
  };
}

After you set the data visibility of a model element category, you can configure the data access
method to determine how the get and set methods are generated for the data elements. This
configuration controls how application code can view and modify the class member data. Each option
and its impact on the generated C++ class interface, declared in the model header file, is outlined:
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Member Access Method
Options

Description

Method If you configure inports as Method, a set method appears for each
inport. If you configure outports as Method, a get method appears
for each outport in the model. If you configure the other model
element categories as Method, an aggregate structure-based get
and set method appears for the data element category.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // example inport
   void setInport(real_T localArgInput);

   // example outport
   real_T getOutport() const;

   // example of model parameter arguments configured with
   // ‘DataAccess’ ‘Direct'
   real_T const & getInstP() const;

   // example of model parameter arguments configured with
   // ‘DataAccess’ ‘Pointer’
   // real_T const * getInstP() const;

   // example Block parameters get and set methods
   const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_P &
     getBlockParameters() const;
 
   void setBlockParameters(const rtwdemo_cppclass_workflow_P
     *prtwdemo_cppclass_workflowrtrtP);

   // example Block states get and set methods
  const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_DW &
    getDWork() const;
 
  void setDWork(const rtwdemo_cppclass_workflow_DW
                *prtwdemo_cppclass_workflowrtDW);
    
   private:
    … 
  };
}
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Member Access Method
Options

Description

Inlined method If you configure inports as Inlined method, a set method
defined in its declaration appears for each inport. If you configure
outports as Inlined method, a get method defined in its
declaration appears for each outport in the model. If you configure
the other model element categories as Inlined method, an
aggregate structure-based get and set method defined in its
declaration appears for the data element category.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // example inport set method
   void setkeyState(real_T localArgInput)
   {
     rtU.keyState = localArgInput;
   }
 
   // example outport get method
   const real_T* getengineState() const
   {
     return rtY.engineState;
   }

   // example Block parameters get and set method
   const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_P &
     getBlockParameters() const
   {
     return rtwdemo_cppclass_workflowrtrtP;
   }
 
   void setBlockParameters(const rtwdemo_cppclass_workflow_P
     *prtwdemo_cppclass_workflowrtrtP)
   {
     rtwdemo_cppclass_workflowrtrtP = *prtwdemo_cppclass_workflowrtrtP;
   }

  // example Block states get and set methods
   const rtwdemo_cppclass_workflowModelClass::rtwdemo_cppclass_workflow_DW &
     getDWork() const
   {
     return rtwdemo_cppclass_workflowrtDW;
   }
 
   void setDWork(const rtwdemo_cppclass_workflow_DW
                 *prtwdemo_cppclass_workflowrtDW)
   {
     rtwdemo_cppclass_workflowrtDW = *prtwdemo_cppclass_workflowrtDW;
   }
     
   private:
    … 
  };
}
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Member Access Method
Options

Description

Structure-based method If you configure the inports as Structure-based method, the
inports appear as an aggregate structure-based set method for the
model element category. If you configure the outports as
Structure-based method, the outports appear as aggregate
structure-based get method for the model element category. This
configuration option does not apply to the other model element
categories.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
    // public data and function members
   public:
   // example inport
   void setExternalInputs(const ExtU_demoMethodScheduledModel_T 
      * pExtU_demoMethodScheduledModel_T);
 
   // example outport 
   const myNamespace::myModelClass::ExtY_demoMethodScheduledModel_T
      & getExternalOutputs() const;

    // Other model element categories may not be configured as ‘Structure-based method’
        
   private:
    … 
  };
}

Inlined structure-based method If you configure the inports as Structure-based method, the
inports appear as aggregate structure-based set method defined in
its declaration for the model element category. If you configure the
outports to Structure-based method, the outports appear as
aggregate structure-based get method defined in their declaration
for the model element category. This configuration option does not
apply to the other model element categories.
File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // example inport
   void setExternalInputs(const ExtU_demoMethodScheduledModel_T
      * pExtU_demoMethodScheduledModel_T)
   {
      demoMethodScheduledModelWithR_U = *pExtU_demoMethodScheduledModel_T;
   }
 
    // example outport
   const myNamespace::myModelClass::ExtY_demoMethodScheduledModel_T
      & getExternalOutputs() const
   {
      return demoMethodScheduledModelWithR_Y;
   }
   // Other model element categories may not be configured as ‘Inlined structure-based method’
    
   private:
    … 
  };
}
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Member Access Method
Options

Description

None If you configure the access of a model element category as None,
get and set methods do not appear in the generated class and data
can be accessed directly by application code.

File: rtwdemo_cpp_workflow.h

  // External inputs (root inport signals with default storage)
  struct ExtU {
    real_T keyState;                   // '<Root>/keyState'
  };
 
  // External outputs (root outports fed by signals with default storage)
  struct ExtY {
    real_T engineState[3];             // '<Root>/engineState'
    real_T cycleTime;                  // '<Root>/cycleTime'
  };

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
   // External inputs
   ExtU rtU;
 
   // External outputs
   ExtY rtY;
        
   private:
    … 
  };
}

For each model element category, valid data visibility and member access method combinations are
outlined:

Model Element Category Data Visibility Member Access Method
Inports private Method

Inlined method

Structure-based method

Inlined structure-based method
public None

Method

Inlined method

Structure-based method

Inlined structure-based method
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Model Element Category Data Visibility Member Access Method
Outports private Method

Inlined method

Structure-based method

Inlined structure-based method
public None

Method

Inlined method

Structure-based method

Inlined structure-based method
Model parameter arguments Individual arguments None

private Method

Inlined method
Model parameters private None

Method

Inlined method
public None

Method

Inlined method
Signals, states, and internal
data

private None

Method

Inlined method
public None

Method

Inlined method

Workflow

To programmatically configure class member visibility and access, get the Code Mappings object for
the model and set the data access and visibility properties:

1 Get the Code Mappings object for the model. To get the object, use the function
coder.mapping.api.get.

% Get the Code Mappings object
cm = coder.mapping.api.get(model);

 Programmatically Configure C++ Interface

42-35



2 Configure the visibility. To set the data visibility of a category of Simulink data elements in the
generated code, use the function setData. When you use the setData function, specify the
Code Mappings object, model element category, data visibility property, and data visibility option.
Valid data visibility options vary depending on the model element category.

% Set the data visibility of Simulink model data elements by category 
% setData(Code Mappings object, model element category, 'DataVisibility', data visibility option)
setData(cm, 'Outports', 'DataVisibility', 'private');

To verify the data visibility setting before generating code, use the function getData:

% Get the data visibility of Simulink model data elements by category 
% getData(code mappings object, model element category, 'DataVisibility')
getData(cm, 'Outports', 'DataVisibility');

3 Configure the access. To set the member access method of a category of Simulink data elements
in the generated code, use the function setData. When you use the setData function, specify
the Code Mappings object, model element category, member access method property, and
member access method option. Valid member access method options vary depending on the
model element category and selected data visibility option.

% Set the access of Simulink model data elements by category 
% setData(Code Mappings object, model element category,... 
% 'MemberAccessMethod', member access method option)
setData(cm, 'Inports', 'MemberAccessMethod', 'Method');

To verify the member access method setting before generating code, use the function getData:

% Get the visibility of Simulink model data elements by category 
% getData(code mappings- C++ object, model element category, 'MemberAccessMethod')
getData(cm, 'Inports', 'MemberAccessMethod');

Configure Model Functions as Class Methods
Configure the class method names and arguments. When you generate C++ code from a model,
model functions appear as class methods in the generated code. To integrate with external code or
interface requirements, you can customize the name of the generated class methods. Additionally, for
base-rate periodic functions and Simulink Functions, you can configure the name, order, and
identifier of the generated arguments.

The generated class methods are referred to as entry-point methods and are locations in code where
a transfer of program control (execution) occurs. Entry-point methods vary depending on the type of
Simulink model and can be grouped into the following types:

Model Type Type of Model
Function

Description Name of Model
Function

Expected Method
Name

Export-Function
Models

Exported function The exported
function for a
subsystem.

ExportedFuncti
on:slIdentifie
r, where
slIdentifier is
the name of the
function-call Inport
block in the model

function-call-
inport-block-
name or signal-
label (if
specified)
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Model Type Type of Model
Function

Description Name of Model
Function

Expected Method
Name

Simulink Function The exported
function for a
Simulink Function
block.

Simulink
Function:slIde
ntifier, where
slIdentifier is
the name of the
Simulink Function
block in the model

function-name
for a global
Simulink Function
block or
model_function
-name for a scoped
Simulink Function
block

Export-Function or
Rate-based Models

Initialize function Initialization code
for a model. At the
start of the
application code,
call the function
once. Do not use
this function to
reset the real-time
model data
structure (rtM).

Initialize model_initiali
ze

Partition function For a model
partition, output
and update code.
Model
configuration
parameter Single
output/update
function is
selected (the
default).

Partition:slId
entifier, where
slIdentifier is
a partition that
was created
explicitly from a
block in the model
and shown in the
Simulink®
Schedule Editor
(for example, P1)

model_stepn,
where n uniquely
identifies the
function generated
for one of the
model sample
periods

Periodic
multitasking
function

For blocks in a
rate-based model
configured for
multitasking,
output and update
code. The code
generator
produces a
function for each
sample period.
Model
configuration
parameter Single
output/update
function is
selected (the
default).

Periodic:slIde
ntifier, where
slIdentifier is
an annotation that
corresponds to the
sample time period
for a periodic or
continuous rate of
a multitasking
model (for
example, D1)

model_stepn,
where n uniquely
identifies the
function generated
for one of the
model sample
periods
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Model Type Type of Model
Function

Description Name of Model
Function

Expected Method
Name

Periodic single-
tasking function

For blocks in a
rate-based model
configured for
single-tasking,
output and update
code. Model
configuration
parameter Single
output/update
function is
selected (the
default).

Periodic model_step

Reset function If the model
includes a Reset
Function block,
reset code
generated. To reset
conditions or state,
call the function
from the
application code.

Reset:slIdenti
fier, where
slIdentifier is
the name of the
reset function in
the model

model_reset-
function-name

Terminate function Code for turning
off a system. For
ERT-based models,
you can suppress
generation of this
function by
clearing the model
configuration
parameter
Terminate
function
required (set by
default).

Terminate model_terminat
e

The generated C++ class interface, declared in the model header file, incorporates the function name
and argument customizations in the generated entry-point methods:

File: rtwdemo_cpp_workflow.h

namespace CustomizedNamespace
{
  class customized_ModelClass {
   public:
    // model initialize function- customized name
   void customized_initialize();

    // model step function- customized name & arguments
   void customized_step(customArg1, const* customArg2);
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    // model terminate function- customized name
   void customized_terminate();

    // Constructor
   customized_ModelClass();

    // Destructor
   ~customized_ModelClass();
 
   private:
  … 
  };
}

Workflow

To programmatically configure class method names and arguments, get the Code Mappings object for
the model and set the function properties:

1 Get the Code Mappings object for the model. To get the object, use the function
coder.mapping.api.get.

% Get the Code Mappings object
cm = coder.mapping.api.get(model);

2 To view the available entry-point methods for the model, use the function find. When you use
the find function, specify the Code Mappings object and the function category you would like to
view for the model. Valid function category options are the following:

• Functions
• PeriodicFunctions
• PartitionFunctions
• ExportedFunctions
• ResetFunctions
• SimulinkFunctions

% View entry-point methods for a model by category 
% This example shows how to view the entry-point functions for a model
% find(Code Mappings object, function category')
find(cm, 'Functions');

3 Configure method names. To configure the method name of an entry-point method, use the
function setFunction. When you use the setFunction function, specify the Code Mappings
object, model function name, the method name property, and the custom name. Valid model
function names are specified in the following way:

• Initialize — Initialize function.
• Terminate — Terminate function.
• Periodic:slIdentifier — Periodic function (implicit task), where slIdentifier is the

annotation (for example, D1) corresponding to the sample time period. Periodic is sufficient
for a single-tasking periodic function.

• Partition:slIdentifier — Partition function (explicit task), where slIdentifier is the
partition name in Schedule Editor.

• Reset:slIdentifier — Reset function where slIdentifier is name of the reset function
in model.
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• ExportedFunction:slIdentifier — Exported function where slIdentifier is the
name of function-call inport block.

• ExportedFunction:slIdentifier — Simulink function where slIdentifier is the name
of Simulink function in model.

% Set the name of individual entry-point methods 
% This examples shows how to customize the name of a periodic function
% setFunction(Code Mappings object, model function, 'MethodName', custom name)
setFunction(cm, 'Periodic', 'MethodName', 'custom_Periodic');

To verify the method name before generating code, use the function getFunction:

% Get method name 
% getFunction(code mappings object, model function, 'MethodName')
getData(cm, 'Periodic', 'MethodName');

4 Configure method arguments. For base-rate periodic functions and Simulink Functions, you can
use the function setFunction to configure the generated method arguments. When you use the
setFunction function, specify the Code Mappings object, model function name, the arguments
property, and the method prototype. Valid model function names are specified in the following
way:

• Initialize — Initialize function.
• Terminate — Terminate function.
• Periodic:slIdentifier — Periodic function (implicit task), where slIdentifier is the

annotation (for example, D1) corresponding to the sample time period. Periodic is sufficient
for a single-tasking periodic function.

• Partition:slIdentifier — Partition function (explicit task), where slIdentifier is the
partition name in Schedule Editor.

• Reset:slIdentifier — Reset function where slIdentifier is name of the reset function
in model.

• ExportedFunction:slIdentifier — Exported function where slIdentifier is the
name of function-call inport block.

• ExportedFunction:slIdentifier — Simulink function where slIdentifier is the name
of Simulink function in model.

Valid identifier options for parameters are the following:

Identifier Option Preview
Value (Inports only) myPeriodic(argInport)
Const Reference (Inports only) myPeriodic(const & argInport)
Pointer to Const myPeriodic(const * argInport)
Pointer myPeriodic(* argInport)
Const Pointer to const myPeriodic(const * const argInport)

In the below example, the periodic function, foo, is configured to generate a method where y is
the return argument and its parameter u1 is passed as a scalar and u2 is passed as a constant
pointer:
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% Configure method arguments 
% setFunction(Code Mappings object, function, 'Arguments', function prototype)
setFunction(cm, 'Periodic:foo', 'Arguments', 'y=(u1, const *u2)');

To verify the method arguments before generating code, use the function getFunction:

% Get method name 
% getFunction(Code Mappings object, model function, 'Arguments')
getData(cm, 'Periodic:foo', 'Arguments');

Generate C++ Class Interface
Generate the customized C++ class interface by generating code from the model. To verify your
customized C++ class interface configurations, build the model and view the generated class, class
member, and class method representations.

1 Generate code. To generate a C++ class interface, build the model with the command slbuild.

slbuild example_model
2 View code. To view the generated code, open the model in the Embedded Coder app.

open example_model

To open the Code view, on the C++ Code tab, click View Code. The generated code appears
beside the model in the model workspace.
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3 Iterate. If the generated interface does not meet code requirements, make configuration
adjustments until requirements are satisfied.

If the generated code representation does not meet your requirements, reconfigure the interface and
generate code again until code generations requirements are satisfied. For guidance on
understanding the generated code, see “Analyze the Generated Code Interface” on page 52-13.

Considerations and Limitations
• Instance-Specific Parameter Support — You can use model parameter arguments to configure

workspace variables that have been specified as arguments. You can configure these arguments as
private members of your class or as individual arguments defined outside the class. To configure
within the class, you can set the data visibility setting to private and configure the generation of
the get and set methods. Optionally, you can configure the class member values as defined within
the class (setDatat(cm,'ModelParameterArguments','DataAccess','Direct')) or
passed-by-reference through the class constructor
(setDatat(cm,'ModelParameterArguments','DataAccess','Pointer')). The data access
setting is supported for top model builds. For reference model builds, the code is generated as
references in the model class. To configure instance-specific parameters outside the class, set the
data visibility to individual arguments.

Instance-specific parameter limitations include:

• MATLAB variables marked as model arguments are not able to be configured as private class
members.

• Model parameter arguments are not supported by right-click builds.
• Interface Code Generation Behavior — The I/O arguments style of step method specification

supports single-rate models and multirate single-tasking models. Multirate multitasking models
are not supported. Additionally, the C++ encapsulation interface is not the default, the value is
ignored for the Pass fixed-size scalar root inputs by value for code generation parameter.

• Stateflow considerations — If you have a Stateflow license, for a Stateflow chart that resides in a
root model configured to use the I/O arguments step method function specification, and that
uses a model root inport value or calls a subsystem that uses a model root inport value, do one of
the following to generate code:

• In the Stateflow chart, clear the Execute (enter) Chart At Initialization check box.
• Insert a Simulink Signal Conversion block immediately after the root inport. In the Signal

Conversion block parameters dialog box, select Exclude this block from 'Block reduction'
optimization.

• Simscape Considerations — If a model root inport value connects to a Simscape block, insert a
Simulink Signal Conversion block between the root inport and the Simscape conversion block. In
the Signal Conversion block parameters dialog box, select Exclude this block from 'Block
reduction' optimization.

• Reference Model Considerations — When building a referenced model that is configured to
generate a C++ class interface:

• Do not use a C++ class interface in cases when a referenced model cannot have a combined
output/update function. Cases include a model that has a continuous sample time or saves
states.
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• Do not use virtual buses as inputs or outputs to the referenced model when the referenced
model uses the I/O arguments step method. When bus signals cross referenced model
boundaries, either use nonvirtual buses or use the Default step method.

See Also
coder.mapping.api.CodeMappingCPP | coder.mapping.api.get |
coder.mapping.utils.create | find | getClassName | getClassNamespace | getData |
getFunction | setClassName | setClassNamespace | setData | setFunction

Related Examples
• “Configure C++ Class Interface for Rate-Based Models” on page 42-44
• “Configure C++ Class Interface for Export-Function Models” on page 42-48

More About
• “Interactively Configure C++ Interface” on page 42-2
• “Analyze the Generated Code Interface” on page 52-13
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Configure C++ Class Interface for Rate-Based Models
This example shows how to configure a C++ class interface for a rate-based model. In Simulink you
can create and generate code for a rate-based modeling system that enables you to control the
scheduling of model components. This example shows you how to customize the generated class
name, namespace, class members, and class methods for an example model. This example,
rtwdemo_cppclass, simulates whether a vehicle engine is on or off depending if the ignition has
been turned on.

Interface Goals and Requirements

A primary goal for configuring a C++ class interface for a rate-based model is to customize the
generated code so that it easily integrates with your task scheduler. For this example, the goal is to
update the name and namespace of the class to more meaningful values, distinguish the varied
sample rates, and to simplify and encapsulate the remaining data and functions in the interface.

• To better reflect that this model is an engine status model, update the class name to
engine_status.

• To prevent clashes with other symbols in a project and indicate that the generated code is from
Simulink, update the class namespace to sl.

• To enable the configuration of the name and arguments of the base-rate periodic function,
configure the inports and outports of the model as public class members without a get/set method.

• To enable the calibrate of shared values across multiple instances of the generated model class,
configure the model parameters as private class members with a get/set method.

• To simplify the interface, configure parameter arguments and internal data as private without a
get/set method.

• To make the other entry-point names more meaningful, update the names of the initialize and
terminate entry-rate methods.
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Interactive Example

Configure Model Class Name and Namespace

1. On the C++ Code tab, click Code Interface and select Class Name & Namespace.

2. To configure the class name, in the C++ Class Name field, update the name to engine_status.

3. To configure the class namespace, in the C++ Class Namespace field, update the name to sl.

4. Click OK.

Configure Model Data Elements as Class Members

1. Open the Code Mappings editor. On the C++ Code tab, click Code Interface and select Code
Mappings.

2. Configure the data visibility. For the model element categories:

• Set the Inports and Outports to public and None.
• Set the Model parameters to private and Method.
• Set the Model parameter arguments and Signals, states, and internal data to private and

None.

Configure Model Functions as Class Methods

1. Open the Functions pane. In the Code Mappings editor, click the Functions tab.

2. To view a complete list of entry-point functions for your model, click the Update Diagram button.

3. Configure the periodic functions to distinguish the sample rates.

• To configure the base-rate periodic function, in the Method Preview column, click its method
preview hyperlink.

• Configure the function name. In the Step Function Interface configuration dialog box C++ Step
Function Name field, update the function name to EngineEntrypoint.

• Open the arguments viewer. In the dialog box, select Configure arguments for Step function
prototype and click Get default.

• Configure the argument names. In the C++ Identifier Name column, click and edit the names to
keyState arg_keyState, engineState arg_engineState, cycleTime arg_cycleTime.

• Configure the argument identifiers. In the C++ Type Qualifier column, select the appropriate
identifier from the drop-down options. Configure keyState arg_keyState as value,
engineState arg_engineState as Pointer, and cycleTime arg_cycleTime as Pointer.

• Change the order of the arguments. Click and drag the argument rows in the viewer to the
following order: keyState arg_keyState, engineState arg_engineState, and cycleTime
arg_cycleTime.

• Verify the arguments selections. Click Validate.
• To apply changes and exit the dialog box, click OK.

4. Configure the other entry-point methods.

• Configure the Initialize function name. In the Method Name column, click and edit the
spreadsheet to change the name to initIntegrator.
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• Configure the Terminate function name. In the Method Name column, click and edit the
spreadsheet to change the name to terminateReadIntegrator.

5. Verify the method prototypes for all entry-point functions in the Method Preview column.

Generate the Interface

1. Generate code. To generate a C++ class interface, on the C++ Code tab, click Build.

2. View code. To view the generated code, on the tab click View Code. The generated code appears
beside the model in the model workspace.

Programmatic Example

To programmatically configure a C++ class interface for the rtwdemo_cppclass model, use this
workflow:

Open the example model

model ='rtwdemo_cppclass';
open_system(model);

% Get the C++ mapping object
cm = coder.mapping.api.get(model);

Configure Model Class Name and Namespace

% Configure the C++ class name
setClassName(cm,'engine_status');
% Configure the enclosing namespace
setClassNamespace(cm,'sl');

Configure Model Data Elements as Class Members

% Configure the inports and outport to pass external data directly to
% the base-rate periodic function in the modeled application. This
% configuration enables you to later configure the name and arguments for
% the base-rate periodic function
setData(cm, 'Inports', 'DataVisibility', 'public');
setData(cm, 'Outports', 'DataVisibility', 'public');
setData(cm, 'Inports', 'MemberAccessMethod', 'None');
setData(cm, 'Outports', 'MemberAccessMethod', 'None');

% Configure model parameters so that you can adjust calibration values
setData(cm, 'ModelParameters','DataVisibility','private');
setData(cm,'ModelParameters', 'MemberAccessMethod','Method');

% Configure Model Parameter Arguments and Iternal data as encapsulated and simple
setData(cm, 'ModelParameterArguments', 'DataVisibility', 'private');
setData(cm, 'ModelParameterArguments', 'MemberAccessMethod', 'None');
setData(cm, 'InternalData', 'DataVisibility', 'private');
setData(cm, 'InternalData', 'MemberAccessMethod', 'None');

Configure Model Functions as Class Methods

% To configure the periodic functions, use the find function to
% retrieve the periodic functions for the model
periodic_functions = find(cm, 'Periodic');
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% Configure the base-rate periodic function method name
setFunction(cm, periodic_functions, 'MethodName', 'EngineEntrypoint');

% Configure the base-rate periodic function arguments
setFunction(cm, periodic_functions,'Arguments',...
    '(const & keyState arg_keyState, * engineState arg_engineState, * cycleTime arg_cycleTime)');

% Configure the initialize and terminate function names
setFunction(cm,'Initialize','MethodName', 'initIntegrator');
setFunction(cm,'Terminate', 'MethodName', 'terminateReadIntegrator');

Generate The Interface

Build the application model to generate the C++ class interface.

See Also
Code Mappings- C++ Editor | coder.mapping.api.CodeMappingCPP

Related Examples
• “Interactively Configure C++ Interface” on page 42-2
• “Programmatically Configure C++ Interface” on page 42-25
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Configure C++ Class Interface for Export-Function Models
This example shows how to configure a C++ class interface for an export-function model. Export-
function modeling enables you to generate code for event-triggered functions that can be integrated
with an external environment or a scheduler. Functions are defined using Function-Call Subsystem,
function-call Model, Simulink Function, and S-Function blocks. This example shows you how to
customize the generated class name, namespace, class members, and class methods for an example
model. This example, rtwdemo_cppclass_expfcn, provides a set of functions you might customize
in a typical export-function model.

Interface Goals and Requirements

A primary goal for configuring the generated C++ code from an export-function model is to be able to
customize event-driven behavior. For this example, the goal is to update the name and namespace of
the class to more meaningful values, customize the export functions, and to simplify and encapsulate
the remaining data and functions in the interface.

• To better reflect the event-driven behavior in the model, update the class name to
triggered_events.

• To prevent clashes with other symbols in a project and to indicate that the generated code is from
Simulink, update the class namespace to sl.

• To simplify and encapsulate the data, set the model elements to private with a get/set method.
• To customize the functions, customize the names of the export-functions.
• To make the other entry-point names more meaningful, update the names of the initialize and

terminate entry-point methods.
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Interactive Example

Configure Model Class Name and Namespace

1. On the C++ Code tab, click Code Interface and select Class Name & Namespace.

2. To configure the class name, in the C++ Class Name field, update the name to
triggered_events.

3. To configure the class namespace, in the C++ Class Namespace field, update the name to sl.

4. Click OK.

Configure Model Data Elements as Class Members

1. Open the Code Mappings editor. On the C++ Code tab, click Code Interface and select Code
Mappings.

2. Configure the data visibility. For the model element categories:

• Set the Inports and Outports to private and Method.
• Set the Model parameters to private and Method.
• Set the Model parameter arguments to private and Method.
• Set the Signals, states, and internal data to private and Method.

Configure Model Functions as Class Methods

1. Open the Functions pane. In the Code Mappings editor, click the Functions tab.

2. Configure the export function names.

• For the export function, Export Function: event 1, from the Method Name column, click
and edit the spreadsheet to update the name to subsystemEvent1.

• For the export function, Export Function: event 2, from the Method Name column, click
and edit the spreadsheet to update the name to subsystemEvent2.

3. Configure the Initialize function name. In the Method Name column, click and edit the
spreadsheet to change the name to initIntegrator.

4. Configure the Terminate function name. In the Method Name column, click and edit the
spreadsheet to change the name to terminateReadIntegrator.

5. Verify the method prototypes for all entry-point functions in the Method Preview column.

Generate the Interface

1. Generate code. To generate a C++ class interface, on the C++ Code tab, click Build.

2. View code. To view the generated code, on the tab, click View Code. The generated code appears
beside the model in the model workspace.

Programmatic Example

To programmatically configure a C++ class interface for the rtwdemo_cppclass_expfcn model,
use this workflow:
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Open the example model

model ='rtwdemo_cppclass_expfcn';
open_system(model);

% Get the C++ mapping object
cm = coder.mapping.api.get(model);

Configure Model Class Name and Namespace

% Configure the C++ class name
setClassName(cm,'event_triggered');
% Configure the enclosing namespace
setClassNamespace(cm,'sl');

Configure Model Data Elements as Class Members

% Configure the inports and outports for the model
setData(cm, 'Inports', 'DataVisibility', 'private');
setData(cm, 'Outports', 'DataVisibility', 'private');
setData(cm, 'Inports', 'MemberAccessMethod', 'Method');
setData(cm, 'Outports', 'MemberAccessMethod', 'Method');

% Configure the model parameters
% static model parameters (shared across all instances)
setData(cm, 'ModelParameters','DataVisibility','private');
setData(cm,'ModelParameters', 'MemberAccessMethod','Method');

% Configure the model parameter agruments
setData(cm, 'ModelParameterArguments', 'DataVisibility', 'private');
setData(cm, 'ModelParameterArguments', 'MemberAccessMethod', 'Method');

% Configure the internal data
setData(cm, 'InternalData', 'DataVisibility', 'private');
setData(cm, 'InternalData', 'MemberAccessMethod', 'Method');

Configure Model Functions as Class Methods

% To configure the export functions, use the find function to
% retrieve all the export functions for the model
exported_functions = find(cm, 'ExportedFunctions');

% Configure the Exported Function names
setFunction(cm, exported_functions{1}, 'MethodName', 'subsystemEvent1');
setFunction(cm, exported_functions{2}, 'MethodName', 'subsystemEvent2');

% Configure the initialize and terminate function names
setFunction(cm,'Initialize','MethodName', 'initIntegrator');
setFunction(cm,'Terminate', 'MethodName', 'terminateReadIntegrator');

Generate The Interface

Build the application model to generate the C++ class interface.

See Also
Code Mappings- C++ Editor | coder.mapping.api.CodeMappingCPP
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Related Examples
• “Interactively Configure C++ Interface” on page 42-2
• “Programmatically Configure C++ Interface” on page 42-25
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Memory Sections in Embedded Coder

• “Control Data and Function Placement in Memory by Inserting Pragmas” on page 43-2
• “Protect Global Data with const and volatile Type Qualifiers” on page 43-13
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Control Data and Function Placement in Memory by Inserting
Pragmas

For some applications, you can use pragmas and other code decorations to control the placement of
data (global variables) and function definitions in memory. For example, a linker configuration file can
define named sections in a SECTIONS directive and map each section to a range of memory
addresses. In the C code, you include pragmas that assign global variables and functions to these
named sections and, by extension, to the memory ranges. By controlling memory placement, you can:

• Generate code that is more efficient for your hardware.
• Modularize your application code for easier maintenance and modification later in the

development process and after deployment.

With Embedded Coder and memory sections, you can:

• Apply default pragmas or other decorations to categories of model data and entry-point functions.
To configure these defaults, use the Code Mappings editor. For example, you can:

• Apply a default pragma to internal data, which includes block states that the code generator
cannot eliminate through optimizations. You can apply a different default pragma to constant
parameters, such as nonscalar parameters that the generated code must store in memory.

• Apply a default pragma to categories of generated functions, including entry-point functions
such as model_step.

• Override the default pragmas for individual data items such as block parameters, states, and
signals. To do so, create your own storage class.

• Override the default pragmas for individual functions that correspond to atomic subsystems,
which you can configure to appear in the generated code as separate functions with separate data.
Use the subsystem parameters dialog box.

Insert Pragmas by Using Memory Sections
In this example, you configure the default memory placement for all of the data and functions of the
algorithm represented by the example model rtwdemo_roll. Then, for some signal data, you
override the default placement.

Explore Example Model and Inspect Default Generated Code

1 Open the example model.

open_system('rtwdemo_roll')
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The model is configured to generate efficient production code. For example, the configuration
parameter Default parameter behavior is set to Inlined.

2 In the Apps gallery, under Code generation, click Embedded Coder. The C Code tab opens.
Generate code from the model.

3 In the code generation report, inspect the file rtwdemo_roll.h. The file defines structure types
that represent data that the algorithm needs. For example, the file defines a structure type that
represents block states such as the states of Discrete-Time Integrator blocks.

/* Block signals and states (default storage) for system '<Root>' */
typedef struct {
  real32_T FixPtUnitDelay1_DSTATE;     /* '<S7>/FixPt Unit Delay1' */
  real32_T Integrator_DSTATE;          /* '<S1>/Integrator' */
  int8_T Integrator_PrevResetState;    /* '<S1>/Integrator' */
} DW;

The file also declares entry-point functions for the model.

/* Model entry point functions */
extern void rtwdemo_roll_initialize(void);
extern void rtwdemo_roll_step(void);

4 Inspect rtwdemo_roll.c. This file defines global structure variables to store the data. The file
also defines the functions.

In this example, assume your linker configuration file defines named sections MYALGORITHM_DATA
and MYALGORITHM_CODE in a SECTIONS directive. You can configure the model so that the generated
code includes pragmas, placing the memory allocated for the data and functions in these named
sections.

• For a global variable named myVar, the pragma syntax is:

#pragma SEC_MYALGORITHM_DATA("myVar")

double myVar;
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• For a function named myFunction, the pragma syntax is the same except for the section name:

#pragma SEC_MYALGORITHM_CODE("myFunction")

void myFunction(void)

Create Memory Sections

In this example, you use two pragmas with different syntaxes, so you must create two memory
sections.

1 Open the Embedded Coder app. On the C Code tab, select Code Interface > Embedded Coder
Dictionary.

2 In the Embedded Coder Dictionary dialog box, select the Memory Sections tab and click the
Add button.

3 For the new memory section, set these options:

• Name to MYALGORITHM_DATA.
• Statements Surround to Each variable.
• Pre Statement to #pragma SEC_MYALGORITHM_DATA("$N"). The token $N stands for the

name of each variable that uses the memory section.
4 Create another, similar memory section that corresponds to MYALGORITHM_CODE.

Configure Default Pragmas for Data and Functions

1 On the C Code tab, select Code Interface > Default Code Mappings or Code Interface >
Individual Element Code Mappings

2 In the Data Defaults tab, expand Inports and Outports, Signals and Parameters.
3 In the table, select the Inports row.
4 In the Property Inspector, set Memory Section to MYALGORITHM_DATA.
5 For the other rows in the table, set Memory Section to MYALGORITHM_DATA.
6 Under Function Defaults, for each row in the table, set Memory Section to

MYALGORITHM_CODE.
7 In your current folder, delete the existing slprj folder.
8 Configure the model to generate only code. Select the configuration parameter Configuration

Parameters > Generate code only.
9 Click Generate Code.

Now, the rtwdemo_roll.c file applies the pragmas to the definitions of the structure variables and
the functions. For each category of data and functions that you configured in the Code Mappings
editor, the code applies a pragma. For example, the code applies the MYALGORITHM_DATA pragma to
each of the structures that store block states, root-level inputs, and root-level outputs.
/* Block signals and states (default storage) */
#pragma SEC_MYALGORITHM_DATA("rtDW")

DW rtDW;

/* External inputs (root inport signals with default storage) */
#pragma SEC_MYALGORITHM_DATA("rtU")

ExtU rtU;

/* External outputs (root outports fed by signals with default storage) */
#pragma SEC_MYALGORITHM_DATA("rtY")

ExtY rtY;
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Retain Default Memory Section After Applying a Default Storage Class or Function Template

In the Code Mappings editor, you can use the Storage Class and Function Customization
Template columns to control the default appearance of data and functions in the generated code.
When you use these columns to apply a setting other than Default, the Code Mappings editor
discards the memory section that you applied in the Property Inspector. To retain the memory section,
use the Embedded Coder Dictionary to create a storage class or function template, then apply the
memory section to that storage class or function template.

In this example, you configure the nonparameter data of the model, such as signals and states, to
appear in the same structure by creating a storage class. To retain the MYALGORITHM_DATA memory
section, you apply the memory section to the storage class.

1 In the Embedded Coder Dictionary for the model, select the Storage Classes tab and click the
Add button.

2 For the new storage class, set:

• Name to STRUCT_DATA.
• Storage Type to Structured.
• Memory Section to MYALGORITHM_DATA.

3 In the Code Mappings editor, under Data Defaults, in the Storage Class column, select
STRUCT_DATA for these rows:

• Inports
• Outports
• Signals, states and internal data

4 Generate code from the model.
5 Inspect rtwdemo_roll.c. Now, the file defines a single structure variable that contains the

nonparameter data, applying the pragma to that variable.

/* Storage class 'STRUCT_DATA' */
#pragma SEC_MYALGORITHM_DATA("STRUCT_DATA_rtwdemo_roll")

rtwdemo_roll_STRUCT_DATA STRUCT_DATA_rtwdemo_roll;

Incorporate Default Memory Section into a Storage Class for Individual Mapping

To override the default storage classes that you specify in Code Mappings - C > Data Defaults,
apply a storage class directly to a data item by using the Code Mappings editor. Directly applying a
storage class other than Auto or Model default bypasses the default memory section that you
specify in Data Defaults. To retain the memory section, create a storage class in the Embedded
Coder Dictionary and apply the desired memory section to it. Then, apply the storage class to
individual data items in the Code Mappings editor. Other models cannot access the storage class and
memory section that you define in the Embedded Coder Dictionary. To share the storage class and
memory section sections among other models, store the Embedded Coder Dictionary in a Simulink
Data Dictionary data (sldd) outside of your model. Then, share the dictionary between the target
models. For more information, see “Migrate Definitions from Model File to Shared Data Dictionary”
on page 31-14.

In rtwdemo_roll, in the BasicRollMode subsystem, the three Gain blocks represent the
parameters of a PID control algorithm. In the “Retain Default Memory Section After Applying a
Default Storage Class or Function Template” on page 43-5 section, configure the nonparameter data
of the model, such as signals and states, to appear in the same structure by applying the default
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storage class STRUCT_DATA. In this example, you configure the output signals of the Gain blocks so
that the generated code allocates memory for them in the MYALGORITHM_DATA section but does not
appear in the default storage class structure. Define a new storage class myStore in the Embedded
Coder Dictionary and apply the desired memory section MYALGORITHM_DATA to it. Then, directly
apply the storage class to the output signals of the Gain blocks.

1 In the Embedded Coder Dictionary of the model, select the Storage Classes tab and click the
Add button.

2 For the new storage class, set:

• Name to myStore.
• Storage Type to Structured.
• Memory Section to MYALGORITHM_DATA.

3 In the model, navigate into the BasicRollMode subsystem. The signals of the subsystem are not
automatically populated into the Code Mappings editor. You need to manually add signals by
pausing on the ellipsis that appears above or below a signal line to open the action bar. Click the
Add Signal button. The button is also available in the Code Mappings editor on the Signals/
States tab.

4 After you add the output signals of the Gain blocks, the signal rows appear in the Code
Mappings -C > Signals/States tab. Open the Property Inspector by selecting the signal rows.
In the Code section, set these properties:

• Storage Class to myStore.
• Identifier to the block names.

5 Generate code from the model.
6 Inspect the generated file rtwdemo_roll.c. The file defines a structure variable

myStore_rtwdemo_roll and applies the pragma to the variable.

/* Storage class 'myStore' */
#pragma SEC_MYALGORITHM_DATA("myStore_rtwdemo_roll")

rtwdemo_roll_myStore myStore_rtwdemo_roll;
7 Inspect the generated file rtwdemo_roll.h. The structure variable contains the output signals

of the Gain blocks. The output signals are now in a different structure but stored in the same
MYALGORITHM_DATA memory section.

/* Storage class 'myStore', for system '<Root>' */
typedef struct {
  real32_T DispGain;                   /* '<S1>/DispGain' */
  real32_T RateGain;                   /* '<S1>/RateGain' */
  real32_T IntGain;                    /* '<S1>/IntGain' */
} rtwdemo_roll_myStore;

Configure Pragma to Surround Groups of Definitions
If your build toolchain requires that a pragma or other decoration surround multiple definitions of
variables or functions at once, in an Embedded Coder Dictionary or the Custom Storage Class
Designer, set Statements surround to Group of variables (the default in the Custom Storage
Class Designer).

Override Default Memory Placement for Individual Data Elements
After you configure memory section defaults in the Code Mappings editor (see “Configure Default C
Code Generation for Categories of Data Elements and Functions” on page 33-15), to override these
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default settings for individual data elements (signals, parameters, and states), create a storage class
and any required memory sections by using the Embedded Coder Dictionary. For more information
see, “Choose Where to Create and Store Memory Section Definition” on page 43-7. When you
create the storage class, set the Memory section property to the appropriate memory section. Then,
use the Code Mappings editor to apply the storage class to individual data elements.

Choose Where to Create and Store Memory Section Definition
To define a memory section, you must choose where to create it: in an Embedded Coder Dictionary or
in a Simulink Shared Dictionary.

• If you need to use the memory section only in the Code Mappings editor, define the memory
section in an Embedded Coder Dictionary.

If you need to use the memory section only in the Code Mappings editor and want to share it with
other models, define the memory section in a Simulink® data dictionary (sldd). For more
information, see “Share Embedded Coder Dictionary Definition Between Models” on page 31-12.

• If you need to use the memory section outside of the Code Mappings editor, define the memory
section in a package. For example, define memory sections in a package to configure memory
sections of an atomic Subsystem. For more information, see “Override Memory Section for Atomic
Subsystem” on page 43-7.

Share Memory Section Definition Between Models
• If you define the memory section in the Embedded Coder Dictionary of a model, you cannot use

the memory section in other models. To share the memory section, migrate the definition to a
Simulink data dictionary (sldd). Then, share the dictionary between the target models. For more
information, see “Migrate Definitions from Model File to Shared Data Dictionary” on page 31-14.

• If you define the memory section in a package by using the Custom Storage Class Designer, any
model can use the memory section. For more information, see “Create Storage Class by Using
Custom Storage Class Designer” on page 38-24. Add the folder containing the package folder to
the MATLAB path (see “What Is the MATLAB Search Path?”).

Override Default Memory Placement for Subsystem Functions and
Data
When you use atomic subsystems to partition the generated code into functions (see “Generate
Subsystem Code as Separate Function and Files” on page 3-10), you can apply different memory
sections to the functions and data of each subsystem. You can also specify that a subsystem not use a
memory section.

• To use different memory sections to override the model-level defaults that you set in the Code
Mappings editor, see “Override Memory Section for Atomic Subsystem” on page 43-7.

• To specify that a subsystem not use a memory section (in other words, to prevent the subsystem
from inheriting the model-level defaults), see “Specify That Atomic Subsystem Does Not Use a
Memory Section” on page 43-8.

Override Memory Section for Atomic Subsystem

The memory sections that you specify for a subsystem override the model-level defaults that you set
in the Code Mappings editor. Use this technique to aggregate the data and instruction code for
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subroutines or subcomponents (represented by subsystems) into different regions of memory. To
apply a memory section directly to an atomic subsystem, define the memory section in a package by
using the Custom Storage Class Designer. You cannot use a memory section that you define in an
Embedded Coder Dictionary. Then, load the package into the model and configure the subsystem
block parameters to specify the memory section.

To create the memory section:

1 In your current folder, create a folder named +myPackage. The folder defines a package named
myPackage. For more information, see “Create Data Class Package” on page 38-15.

To make the package available outside of your current folder, optionally, you can add the folder
containing the +myPackage folder to the MATLAB path.

2 Open the Custom Storage Class designer.

cscdesigner('myPackage');
3 In the Custom Storage Class Designer, select the Memory Section tab.
4 Click New.
5 For the new memory section, set these options:

• Name to MYALGORITHM_DATA.
• Statements surround to Each variable.
• Pre statement to #pragma SEC_MYALGORITHM_DATA("$N").

6 Click Apply and Save.
7 Set your current folder to the folder that contains the +myPackage folder.

To apply the memory section in an atomic subsystem:

1 Configure the Embedded Coder Dictionary of the model to load the target package as described
in “Refer to Code Generation Definitions in a Package”.

2 To configure the target subsystem to specify the memory section, open the subsystem parameters
dialog box. On the Code Generation tab:

• Set Function packaging to Nonreusable function or Reusable function (for
reentrant code).

• If you set Function packaging to Nonreusable function, to enable configuration of
memory sections for the subsystem data, select Function with separate data. If you do not
select Function with separate data, the subsystem data inherits memory sections from the
model or, if applicable, a parent subsystem.

• To apply the MYALGORITHM_DATA memory section directly to the subsystem functions and
data, use these block parameters:

• Memory section for initialize/terminate functions
• Memory section for execution functions
• Memory section for constants
• Memory section for internal data
• Memory section for parameters

Specify That Atomic Subsystem Does Not Use a Memory Section

By default, subsystem functions and data inherit the model-level memory sections that you specify for
relevant function and data categories in the Code Mappings editor. For example, if you specify a
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function customization template for the Execution category, and that template carries a memory
section, the memory section applies to subsystem execution functions as well as model entry-point
execution functions.

To specify that a subsystem does not use a memory section, open the subsystem parameters dialog
box. On the Code Generation tab, set these parameters to Default:

• Memory section for initialize/terminate functions
• Memory section for execution functions
• Memory section for constants
• Memory section for internal data
• Memory section for parameters

With these settings, the subsystem does not use a memory section for the data or functions that each
parameter represents.

Limitations and Other Considerations

• The settings that you specify for an atomic, nonreusable subsystem with separate data apply only
to the data and functions of that subsystem, not to data in similarly configured child subsystems.
Atomic, nonreusable child subsystems with separate data can inherit memory sections from the
containing model, not from the parent subsystem.

• If you use Build This Subsystem or Build Selected Subsystem to generate code for an atomic
subsystem that specifies memory sections, the code generator ignores the subsystem-level
specifications and uses the model-level specifications instead. For information about building
subsystems, see “Generate Code and Executables for Individual Subsystems”.

Share Memory Section Between Packages (Package Memory Sections
Only)
Packages can access and use memory sections that are defined in other packages, including custom
packages and built-in packages such as Simulink. Only one copy of the memory section exists, in the
package that defines it. Other packages refer to the memory section by pointing to it in its original
location. Changes to the memory section, including changes to a built-in memory section in later
MathWorks product releases, are immediately available in every referencing package.

To configure a package to refer to a memory section that is defined in another package:

1 Open the Custom Storage Class Designer. At the command prompt, enter cscdesigner.
2 Select the Memory Section tab.
3 Use Select Package to select the package in which you want to reference a class or section

defined in some other package.
4 In the Memory section definitions pane, select the existing definition below which you want to

insert the reference.
5 Click New Reference.

A new reference with a default name and properties appears below the previously selected
definition. The new reference is selected, and a Reference tab appears that shows the
reference's initial properties.
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6 Use the Name field to enter a name for the new reference. The name must be unique in the
importing package, but can duplicate the name in the source package.

7 Set Refer to memory section in package to specify the package that contains the memory
section that you want to reference.

8 Set Memory section to reference to specify the memory section to be referenced.
9 Click OK or Apply to save the changes to memory. To save the changes permanently, click Save.

Control Appearance of Memory Section Drop-Down List (Package
Memory Sections Only)
When you apply a package memory section, you select the memory section from a drop-down list. To
control the order of the memory sections in the list, in the Custom Storage Class Designer, use the Up
and Down buttons. The order of memory sections in drop-down lists matches the order in the Custom
Storage Class Designer.

Protect Definitions of Package Memory Sections (Package Memory
Sections Only)
When you click Save in the Custom Storage Class Designer, the Designer saves memory section and
custom storage class definitions into the csc_registration.m file in the package folder. To
determine the location of this file, in the Custom Storage Class Designer, inspect the value of
Filename.

You can prevent changes to the memory section definitions of an entire package by converting the
csc_registration.m file from a MATLAB file to a P-file. Use the pcode function.

A best practice is to keep csc_registration.m and csc_registration.p in your package folder.
That way, if you need to modify the memory sections by using the Designer, you can delete
csc_registration.p and later regenerate it after you finish the modifications. Because the P-
coded version of the file takes precedence, while both files exist in the package, the memory sections
are protected.

.

Limitations
• The code generator does not apply memory sections to data that uses these built-in storage

classes:

• ExportedGlobal
• ImportedExtern
• ImportedExternPointer

• In the Custom Storage Class Designer, the storage type qualifier that you specify for a memory
section by using the Qualifier text box affects only data items that use a storage class setting
other than these built-in storage classes:

• ExportedGlobal
• ImportedExtern
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• ImportedExternPointer

The code generator omits the qualifier from other data categories.
• When you create a subsystem in a custom block library, you cannot specify memory sections for

the subsystem definition in the library. Instead, specify memory sections for the subsystem
instances that you place in your models.

Insert Pragmas for Functions and Data in Generated Code
This example shows how to insert pragmas in generated code to control the placement of data and
functions in memory. To configure memory placement for subsystem functions, use the memory
sections that you define in a package. This example illustrates how to use memory sections defined in
a package to insert pragmas for functions and data in the generated code.

Explore Example Model

Open the example model.

open_system('rtwdemo_memsec')

1 To view the memory sections in the ECoderDemos package, click the Memory Section
Definitions button in the model and then select the Memory Sections tab.

2 To configure the memory sections for functions and data, click the Configure Memory Sections
For This Model button. In the Code Mappings editor, select the appropriate row, and then
specify memory sections in the Property Inspector.

3 The model-level settings are the default settings for atomic subsystems. Open the subsystem
parameter drop-down lists to see the memory section settings for each of the atomic subsystems
in the model. You can override the default model-level setting by configuring the subsystem block
parameters.
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4 To generate code, click the Generate Code Using Embedded Coder button. A code generation
report opens automatically. Inspect the data and function definitions in the .c files and observe
how the generated pragmas correspond to the specified memory sections.

See Also

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
• “Create Storage Classes by Using the Custom Storage Class Designer” on page 38-15
• “Protect Global Data with const and volatile Type Qualifiers” on page 43-13
• “Data Structures in the Generated Code” on page 34-31
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Protect Global Data with const and volatile Type Qualifiers
In C, you use the type qualifier const to prevent code in an application from assigning a new value to
a variable. In an application where an external actor (for example, a hardware device) can manipulate
the value of a variable, you use the keyword volatile to prevent a compiler from optimizing the
assembly code in a way that compromises the integrity of the variable value. You can also use
volatile to prevent a compiler from eliminating storage for const data, such as a parameter that
has a value that you want to tune during execution.

• To apply the qualifiers to an individual data item in a model, including a custom structure that you
create by using a nonvirtual bus or a parameter structure, apply the appropriate predefined
storage class directly to the data item. The storage class prevents optimizations such as Default
parameter behavior from eliminating storage for the data item. For an example, see “Type
Qualifiers” on page 25-12. For information about optimizations that a directly applied storage
class prevents, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on
page 34-49.

If the predefined storage classes do not meet your requirements, you can create your own custom
storage class. To make your custom storage class apply the qualifiers, in the Custom Storage Class
Designer, set Memory section to the appropriate built-in memory section or to a memory section
that you create. For more information, see “Create Storage Classes by Using the Custom Storage
Class Designer” on page 38-15.

• You can apply the qualifiers to a category of model data by default, such as parameters or states.
As you add blocks to a model, new data items in these categories carry the qualifiers that you
specify. For more information, see “Configure Default Code Generation for Data” on page 33-16.

If the predefined storage classes do not meet your requirements, you can create your own by
using an Embedded Coder Dictionary. In the Dictionary, for your new storage class, select the
appropriate check boxes under Qualifiers. For more information, see “Create Code Definitions for
Use in the Code Mappings Editor” on page 31-2.

Maintain const Correctness for Arguments of Entry-Point Functions
When your external code calls a generated entry-point function and passes const data through an
argument (formal parameter) of the function, to make the corresponding argument in the function
definition const, customize the execution (step) entry-point function interface.

• To configure the step entry-point function interface for a model, see “Configure Name and
Arguments for Individual Step Functions” on page 33-118.

• To configure the step entry-point function interface for a Simulink Function block, see “Configure
Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” on page 40-2.

Incorrect Results or Undefined Behavior When Passing Volatile Data to
a Generated Function
The generated code can define and call functions other than model entry-point functions. For
example, you can configure an atomic subsystem to appear in the code as a separate function. Also,
lookup table blocks, such as n-D Lookup Table, typically yield separate utility functions.

When the generated code defines a function that has an argument (formal parameter), the function
definition does not apply volatile to the argument. Therefore, when other generated code or your
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external code calls the function and passes a volatile variable as the value of the argument, the called
function implicitly casts away the volatility.

If your application executes the called function while the value of the volatile data changes, the
function can yield incorrect results or undefined behavior. In particular, for lookup table data that you
prepare for calibration, by applying const and volatile, make sure that you do not calibrate the
data while your application executes the lookup utilities.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on

page 56-69
• “Create Tunable Calibration Parameter in the Generated Code” on page 34-109
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
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Column-Major Layout to Row-Major Layout Conversion of
Models with Lookup Table Blocks

Simulink® Coder™ supports row-major array layout for code generation. You can integrate existing
applications that use row-major array layout with the generated code in row-major array layout.
When you switch an existing model with lookup table (LUT) blocks from the column-major array
layout to the row-major array layout, it is recommended to convert the LUT blocks from the column-
major algorithm to the row-major algorithm. The code generated by using row-major algorithm
performs with the best speed and memory usage when operating on table data with row-major array
layout. The code generated by using column-major algorithm performs best with column-major array
layout.

This example shows the workflow of converting a model with LUT blocks from column-major layout to
row-major layout to achieve the best performance on a row-major array layout.

In this example, you:

• Identify the array layout and select the optimized algorithm.
• Preserve semantics through table permutation.
• Generate code by using a row-major algorithm and an array layout.

Simulate and Generate Code by Using Column-Major Algorithms

1. Open the example model rtwdemo_row_lutcol2row_workflow.

open_system('rtwdemo_row_lutcol2row_workflow');
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By default, Simulink configures a model to use column-major algorithms and a column-major array
layout. These parameters are the configuration parameters in the Configuration Parameters dialog
box.

• Math and Data Types > “Use algorithms optimized for row-major array layout” — This parameter
affects simulation and code generation.

• Code Generation > Interface > “Array layout” — This parameter affects only code generation.

2. On the Modeling tab, click Run to simulate the model and observe the output logged in
workspace variable yout.

3. Change your current folder in MATLAB® to a writable folder. On the C Code tab, click Build to
generate C code.

Select Optimized Algorithms for Row-Major Array Layout

Table data with row-major array layout is frequently used in the field of calibration. To interface the
row-major table data with the existing model, update the column-major model to operate efficiently
on row-major table data.

Use the algorithm that is optimized for the specified array layout to achieve the best performance.
For example, use row-major algorithms when Array layout is set as Row-major during code
generation.

1. To enable row-major algorithms, open the Configuration Parameters dialog box. On the Math and
Data Types pane, select the configuration parameter Use algorithms optimized for row-major
array layout. Alternatively, in the MATLAB Command Window, enter:
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set_param('rtwdemo_row_lutcol2row_workflow','UseRowMajorAlgorithm','on');

2. Click Run to simulate the model. Simulink reports errors because it encounters inconsistent
breakpoint and table data between prelookup and interpolation blocks. The causes of this error are
the two semantic changes that occur when you switch from column-major algorithms to row-major
algorithms, that is, when you:

• Select a plane from a 3-D table in interpolation block.
• Select a plane from a 4-D table through a direct lookup table block.

Preserve Semantics by Using Table Permutation

1. For subtable selection before interpolation, or direct lookup that outputs a vector or 2-D matrix,
the model semantics change when you switch from a column-major algorithm to a row-major
algorithm by selecting the configuration parameter Use algorithms optimized for row-major
array layout. To preserve the semantics and fix the previous errors, permute the table data by using
these commands:

T4d_str = get_param('rtwdemo_row_lutcol2row_workflow/Direct LUT','Table');
set_param('rtwdemo_row_lutcol2row_workflow/Direct LUT','Table',...
['permute(',T4d_str,',[3,4,1,2])']);

T3d_str = get_param('rtwdemo_row_lutcol2row_workflow/Interp2','Table');
set_param('rtwdemo_row_lutcol2row_workflow/Interp2','Table',...
['permute(',T3d_str,',[3,1,2])']);
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2. Before you import table data from a file, you must permute the table data in the file. This
permutation keeps the table tunable throughout the simulation and code generation workflow.

Code Generation by Using Row-Major Algorithm and Array Layout

After permuting the table data, Simulink configures the model
rtwdemo_row_lutcol2row_workflow for row-major simulation. The model is equivalent to the
preconfigured model rtwdemo_row_lutcol2row_workflow_rowrow that has permuted table data
and uses a row-major algorithm.

1. Open the example model rtwdemo_row_lutcol2row_workflow_rowrow.

open_system('rtwdemo_row_lutcol2row_workflow_rowrow');

2. To set up these models for row-major code generation, open the Configuration Parameters dialog
box. In addition to enabling the Use algorithms optimized for row-major array layout
configuration parameter, on the Code Generation > Interface pane, set the configuration
parameter Array Layout to Row-Major option. The Array Layout parameter enables the model for
row-major code generation. Alternatively, in the MATLAB Command Window, enter:

% For model 'rtwdemo_row_lutcol2row_workflow_rowrow'
set_param('rtwdemo_row_lutcol2row_workflow_rowrow', 'ArrayLayout','Row-major');
% For model 'rtwdemo_row_lutcol2row_workflow'
set_param('rtwdemo_row_lutcol2row_workflow', 'ArrayLayout','Row-major');

3. In the block dialog boxes, examine the permuted 3-D table.
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4. Change your current folder in MATLAB to a writable folder. On the C Code tab, click Build to
generate C code. In the generated code, observe the table data with row-major array layout
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In the generated code, the memcpy function replaces the for loops. Using memcpy reduces the
amount of memory for storing data. This optimization improves execution speed.
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Observe the algorithms optimized for row-major data.

close_system('rtwdemo_row_lutcol2row_workflow',0);
close_system('rtwdemo_row_lutcol2row_workflow_rowrow',0);

See Also

Related Examples
• “Code Generation of Matrices and Arrays” on page 50-60
• “Interpolation Algorithm for Row-Major Array Layout” on page 44-9
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Interpolation Algorithm for Row-Major Array Layout
This example illustrates the interpolation algorithm in 2-D and 3-D Lookup Table that is optimized for
row-major array layout. The interpolation algorithm that is optimized for column-major array layout is
also presented as a reference. The code generated by using row-major interpolation algorithm
performs with the best speed and memory usage when operating on table data with row-major array
layout. The code generated by using column-major interpolation algorithm performs best with
column-major array layout.

In this example, you:

• Interpolate on a 2-D Lookup Table with column-major and row-major algorithm.
• Generate code with a row-major algorithm and an array layout.
• Identify the array layout and select the optimized algorithm.
• Interpolate on a 3-D Lookup Table with column-major and row-major algorithm.

Simulate with 2-D Row-Major Algorithm

1. Open the example model rtwdemo_row_lut2d.

model = 'rtwdemo_row_lut2d';
open_system(model);

2. By default, Simulink configures a model with column-major algorithm and column-major array
layout. The model rtwdemo_row_lut2d is configured to use column-major algorithm. Simulate the
model. To observe the output, open the Data Inspector from the Simulation tab. The output value is
4.

3. To enable row-major algorithms, open the Configuration Parameters dialog box. On the Math and
Data Types pane, enable the configuration parameter “Use algorithms optimized for row-major array
layout”. Alternatively, in the MATLAB Command Window, enter:

set_param(model,'UseRowMajorAlgorithm','on');

4. Simulate the model and observe those results in the Data Inspector. The output value is 4.

The column-major and row-major algorithms differ only in the interpolation order. In some cases, due
to different operation order on the same data set, you might experience minor numeric differences in
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the outputs of column-major and row-major algorithms. For the 2-D Lookup Table used in the example
model, the interpolation algorithm is illustrated here.

Generate Code by Using Row-Major Algorithm and Array Layout

The 2-D table data used in model rtwdemo_row_lut2d is:

Table_3by2.Value

ans =

     1     4
     2     5
     3     6

1. Open the Configuration Parameters dialog box. In addition to enabling the Use algorithms
optimized for row-major array layout configuration parameter, on the Code Generation >
Interface pane, set the configuration parameter “Array layout” to Row-Major option. This
configuration parameter enables the model for row-major code generation. Alternatively, in the
MATLAB Command Window, enter:

set_param(model, 'ArrayLayout','Row-major');

2. Change your current folder in MATLAB® to a writable folder. On the C Code tab, click Build to
generate C code.

3. In the generated code, observe the table data with row-major array layout. For comparison, here is
the table data in the generated code for column-major array layout.
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In the generated code, the table data is in row-major order and the interpolation algorithm is
optimized for row-major array layout. The row-major algorithm operates on table data that is
contiguous in memory. This leads to faster cache access, making these algorithms cache-friendly.

This table summarizes the relationship between array layout and cache-friendly algorithms. It is
recommended to use the algorithm that is optimized for the specified array layout to achieve good
performance. For example, use row-major interpolation algorithm when the array layout is set to
Row-Major for code generation.

Interpolation on a 3-D Table

1. Open the example model rtwdemo_row_interpalg.

open_system('rtwdemo_row_interpalg');
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2. Generate code for the model by using the preceding procedure. Simulate and generate code from
the model by repeating the steps performed on rtwdemo_row_lut2d model.

The row-major and column-major interpolations on the 3-D table used in the example model are
illustrated here.
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close_system('rtwdemo_row_lut2d',0);
close_system('rtwdemo_row_interpalg', 0);

See Also

Related Examples
• “Code Generation of Matrices and Arrays” on page 50-60
• “Interpolation with Subtable Selection Algorithm for Row-Major Array Layout” on page 44-15
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Interpolation with Subtable Selection Algorithm for Row-Major
Array Layout

This example illustrates the algorithm for interpolating a subtable that the interpolation block selects
from a higher dimension table. The interpolation algorithm with subtable selection is optimized for
row-major array layout. As a reference, see the interpolation algorithm with subtable selection that is
optimized for column-major array layout. The code generated by using row-major interpolation
algorithm performs with the best speed and memory usage when operating on table data with row-
major array layout. The code generated by using column-major algorithm performs best with column-
major array layout.

In this example, you:

• Interpolate on a selected subtable with column-major and row-major algorithm.
• Preserve block semantics through table permutation.
• Generate code with row-major algorithm and array layout.

Simulate by Using Row-Major Algorithm

1. Open example model rtwdemo_col_interpselsubtable and
rtwdemo_row_interpselsubtable.

open_system('rtwdemo_col_interpselsubtable');
open_system('rtwdemo_row_interpselsubtable');
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2. By default, Simulink configures a model with column-major algorithm and column-major array
layout. The model rtwdemo_col_interpselsubtable is configured to use a column-major
algorithm. Run the model and observe the output stored in workspace variable yout.

3. To enable row-major algorithms, open the Configuration Parameters dialog box. On the Math and
Data Types pane, select the configuration parameter “Use algorithms optimized for row-major array
layout” Alternatively, in the MATLAB Command Window, enter:

set_param('rtwdemo_col_interpselsubtable','UseRowMajorAlgorithm','on');

4. Simulate the model and observe the error.

The column-major and row-major algorithms differ in terms of subtable selection and interpolation
order. The subtable selection is performed inside the original table. No extra memory is allocated for
the subtable. The selected subtable is contiguous in memory. The interpolation order is cache-friendly
for column-major algorithms with column-major array layouts and row-major algorithms with row-
major array layouts. This illustration compares the row-major and column-major interpolations with
subtable selection.
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Due to a change in semantics, column-major and row-major interpolations are performed on different
subtables or data sets. This interpolation leads to different numeric outputs or an error.

Preserve Semantics Through Table Permutation

With subtable selection, the model semantics change when switching from a column-major algorithm
to a row-major algorithm. To preserve the semantics or ensure that the same subtable is selected for
interpolation, you need to permute the table data. Otherwise, Simulink might report error if it
encounters inconsistent breakpoint and table data between prelookup and interpolation blocks.

1. The block rtwdemo_col_interpselsubtable/Interp has 3-D table data given as T3d =
reshape([1:24], 3,2,4) and one selection port with input 2 (0-based index). The selected subtable is
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T3d(:,:,3) (1-based index in MATLAB) for the column-major algorithm. To preserve the semantics for
the row-major algorithm on the same model, that is, select the same subtable with same index and
selection port inputs, permute the table as T3d_p = permute(T3d, [3,1,2]). The selected subtable is
T3d_p(3,:,:) (1-based index) for the row-major algorithm.

T3d_str = get_param('rtwdemo_col_interpselsubtable/Interp','Table');
set_param('rtwdemo_col_interpselsubtable/Interp','Table', ...
    ['permute(',T3d_str,',[3,1,2])']);

2. When you import table data from a file, you must permute the table data in the file before
importing it. This permutation keeps the table tunable throughout the simulation and code generation
workflow.

Generate Code by Using Row-Major Algorithm and Array Layout

After permuting the table data, model rtwdemo_col_interpselsubtable is configured for row-
major simulation. The model is equivalent to the preconfigured model
rtwdemo_row_interpselsubtable that uses a row-major algorithm.

1. To set up the model for row-major code generation, open the Configuration Parameters dialog box.
In addition to selecting the Use algorithms optimized for row-major array layout configuration
parameter, on the Code Generation > Interface pane, set the configuration parameter “Array
layout” to Row-Major option. This configuration parameter enables the model for row-major code
generation. Alternatively, in the MATLAB Command Window, enter:

set_param('rtwdemo_col_interpselsubtable', 'ArrayLayout','Row-major');

2. In the dialog box, examine the permuted 3-D table data and the selected 2-D subtable.
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3. Change your current folder in MATLAB® to a writable folder. On the C Code tab, click Build to
generate C code. In the generated code, observe the 2-D interpolation algorithm optimized for row-
major data.
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close_system('rtwdemo_col_interpselsubtable',0);

See Also

Related Examples
• “Code Generation of Matrices and Arrays” on page 50-60
• “Interpolation Algorithm for Row-Major Array Layout” on page 44-9

44 Array Layout

44-20



Direct Lookup Table Algorithm for Row-Major Array Layout
This example shows how Simulink selects a vector or a 2-D matrix from table data. In a 2-D table, the
output vector can be a column or a row depending on the model configuration setting Use
algorithms optimized for row-major array layout. In this example, the Direct Lookup Table
algorithm is optimized for row-major array layout. The Direct Lookup Table algorithm that is
optimized for column-major array layout is also presented as a reference. The code generated by
using row-major interpolation algorithm performs with the best speed and memory usage when
operating on table data with row-major array layout. The code generated by using column-major
algorithm performs best with column-major array layout.

In this example, you:

• Output a vector or a plane by using direct lookup with a column-major or a row-major algorithm.
• Preserve semantics when switching from a column-major algorithm to a row-major algorithm.
• Generate code by using a row-major algorithm and an array layout.

Simulate by Using Row-Major Algorithm — Output a Vector from 3-D Table

Open example models rtwdemo_row_dlut3d_selvector and rtwdemo_col_dlut3d_selvector.

  open_system('rtwdemo_row_dlut3d_selvector');
  open_system('rtwdemo_col_dlut3d_selvector');
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1. By default, Simulink configures a model with column-major algorithm and column-major array
layout. The model rtwdemo_col_dlut3d_selvector is preconfigured to use column-major
algorithms. Simulate the model and observe the output stored in workspace variable yout.

2. To enable row-major algorithms, open the Configuration Parameters dialog box. On the Math and
Data Types pane, select the configuration parameter “Use algorithms optimized for row-major array
layout” Alternatively, in the MATLAB Command Window, enter:

set_param('rtwdemo_col_dlut3d_selvector','UseRowMajorAlgorithm','on');

3. On the Simulation tab, click Run to simulate the model. Observe the change in output dimension
and numeric values logged in workspace variable yout.

The column-major and row-major algorithms differ semantically in the selection of output vector. For
example, in a 2-D table, Simulink selects a column vector as output for column-major algorithm and a
row vector for row-major algorithm. In a table with a 3-D or higher dimension, Simulink selects the
output vector from the first dimension of the table for a column-major algorithm and from the last
dimension of the table for a row-major algorithm. The elements of the selected vector are contiguous
in the table storage memory. In this example, the last dimension is the third dimension of the 3-D
table. Due to semantic change, column-major and row-major direct lookup table algorithms output
different vector size and numeric values.

These illustrations compare the vector output of row-major and column-major direct lookup table
algorithms in a 3-D table.
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Preserve Semantics by Using Table Permutation

For a direct lookup table that outputs a vector or 2-D matrix, the model semantics change when you
switch from a column-major algorithm to a row-major algorithm. To preserve the semantics or ensure
the same output given the same block I/O connections, you must permute the table data. Otherwise,
Simulink propagates incorrect dimensions to downstream blocks.

1. The block rtwdemo_col_dlut3d_selvector/Direct Lookup Table (n-D) has 3-D table
data T3d = reshape([1:24], 3,2,4) and two input ports with value 0 and 1 (both are 0-based
indices). The selected output vector is T3d(:,1,2) (1-based index) for a column-major algorithm. To
preserve the semantics for a row-major algorithm on the same model, that is, select the same vector
with same index port inputs, permute the table as T3d_p = permute(T3d, [2,3,1]). For a row-major
algorithm, the selected vector is T3d_p(1,2,:).

T3d_str = get_param('rtwdemo_col_dlut3d_selvector/Direct Lookup Table (n-D)','Table');
set_param('rtwdemo_col_dlut3d_selvector/Direct Lookup Table (n-D)','Table',...
['permute(',T3d_str,',[2,3,1])']);

2. When you import table data from a file, you must permute the table data in the file before
importing it. This permutation keeps the table tunable throughout the simulation and code generation
workflow.

Code Generation by Using Row-Major Algorithm and Array Layout

After permuting the table data, Simulink configures the model rtwdemo_col_dlut3d_selvector
for row-major simulation. The model is equivalent to the preconfigured model
rtwdemo_row_dlut3d_selvector that has permuted table data and uses a row-major algorithm.

1. To set up these models for row-major code generation, open the Configuration Parameters dialog
box. In addition to enabling the Use algorithms optimized for row-major array layout
configuration parameter, on the Code Generation > Interface pane, set the configuration
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parameter “Array layout” to the Row-Major option. This configuration parameter enables the model
for row-major code generation. Alternatively, in the MATLAB Command Window, enter:

% For model 'rtwdemo_col_dlut3d_selvector'
set_param('rtwdemo_col_dlut3d_selvector', 'ArrayLayout','Row-major');
% For model 'rtwdemo_row_dlut3d_selvector'
set_param('rtwdemo_row_dlut3d_selvector', 'ArrayLayout','Row-major');

2. In the Direct Lookup Table (n-D) block dialog box, examine the permuted 3-D table data.

3. Change your current folder in MATLAB® to a writable folder. On the C Code tab, click Build to
generate C code. In the generated code, the memcpy function replaces the for loops. Using memcpy
reduces the amount of memory for storing data. This optimization improves execution speed.
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Simulate by Using Row-Major Algorithm — Output a Plane from 3-D Table

open_system('rtwdemo_row_dlut3d_selplane');
open_system('rtwdemo_col_dlut3d_selplane');

1. Open the example model rtwdemo_row_dlut3d_selplane that outputs a plane or 2-D matrix
from a 3-D table.

2. Simulate and generate code from the model by repeating the steps performed on
rtwdemo_col_dlut3d_selvector. The row-major and column-major direct lookup algorithms that
output a 2-D matrix from a 3-D table are illustrated here.
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close_system('rtwdemo_row_dlut3d_selvector',0);
close_system('rtwdemo_col_dlut3d_selvector',0);
close_system('rtwdemo_row_dlut3d_selplane',0);
close_system('rtwdemo_col_dlut3d_selplane',0);

See Also

Related Examples
• “Code Generation of Matrices and Arrays” on page 50-60
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• “Interpolation Algorithm for Row-Major Array Layout” on page 44-9
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Generate Row-Major Code for S-Functions
You can generate row-major code for models that contain S-functions. By default, the code generator
generates column-major code. To learn more about row-major code generation, see “Code Generation
of Matrices and Arrays”.

For an existing model that contains S-functions, when you set the configuration parameter “Array
layout” as Row-major, the configuration parameter “External functions compatibility for row-major
code generation” is enabled and set to error by default. When you try to build the existing model,
you get an error because the S-functions are not enabled for row-major code generation by default.
You can test the compatibility of your S-function for row-major code generation by using the External
functions compatibility for row-major code generation configuration parameter.

This workflow is also applicable to C Caller blocks in a model.

Example

1. Open example model ex_sfcn_rowmajor_unset. The model needs these additional files:

• S-function: ex_sfcn_rowmajor.c
• TLC: ex_sfcn_rowmajor.tlc.

Save these files to your local folder.

open_system('ex_sfcn_rowmajor_unset');

2. The model is configured with Array layout set to Column-major. To enable row-major code
generation, set Array layout to Row-major.

3. When you build the model, the code generator terminates the build and you see this error
message:

4. To proceed, do one of the following:

• If you want to test your existing S-functions with the row-major code for the model, change the
setting of the configuration parameter External functions compatibility for row-major code
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generation to warning or none. The code generator completes the build without generating
row-major code for the S-functions.

• If you want to update your S-functions so that they are compatible with row-major array layout,
use the S-function API to enable the S-function for row-major code generation.

To test your model for S-functions with unspecified array layout, you can also run the Model Advisor
checks on the model. Select the Identify TLC S-functions with unset array layout check and click
the Run This Check button. If the model includes S-functions with unspecified array layout, you see
a warning such as:

To specify the array layout of the user-defined S-function, use the ssSetArrayLayoutForCodeGen
function of the SimStruct API. You can set the enumerated type SSArrayLayout to:

• SS_UNSET – This setting is the default setting that disables the block for row-major code
generation.

• SS_COLUMN_MAJOR – Specify the block for column-major code generation only.
• SS_ROW_MAJOR – Specify the block for row-major code generation only.
• SS_ALL – Specify the block as allowed for code generation regardless of the array layout.

5. Update the ex_sfcn_rowmajor.c file by adding the ssSetArrayLayoutForCodeGen in the
mdlInitializeSizes method:

static void mdlInitializeSizes(SimStruct *S)
{    
    /* Specify array layout of the S-function */
    ssSetArrayLayoutForCodeGen(S, SS_ROW_MAJOR);
    .
    .
    .
}

If your S-function is not affected by an array layout, set SSArrayLayout to SS_ALL.

6. Compile the S-function by using this command in the MATLAB Command Window:
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mex ex_sfcn_rowmajor.c

Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.

7. To build the model and generate code, press Ctrl+B.

If you generate S-functions by using S-Function Builder, use the parameter Array layout to specify
the majority of the S-function. For more information, see “Build S-Functions Automatically Using S-
Function Builder”. If you use the Legacy Code Tool to integrate C functions, use the
convertNDArrayToRowMajor option in legacy_code. The S-Function Builder and Legacy Code
Tool apply preceding transposes when the S-function is set to row-major array layout during
simulation in normal mode.

See Also

Related Examples
• “Integrate C Code Using C Caller Blocks”
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Row-Major Algorithms for Row-Major Array Layout
This example shows how to use row-major algorithms to generate efficient code. You can enable the
“Use algorithms optimized for row-major array layout” configuration parameter to enable efficient
row-major algorithms that are optimized for row-major array layout. The code that you generate by
using row-major algorithms performs with better speed and efficient memory usage when operating
on data with row-major array layout.

In this example, you operate on row-major data by first using the default column-major algorithms,
and then using the row-major algorithms. This comparison helps in identifying the appropriate
algorithm settings to achieve different requirements.

Generate Code by Using the Default Column-Major Algorithms for Row-Major Array Layout

Open the example model ex_rowmajor_algorithm.

model = 'ex_rowmajor_algorithm';
open_system(model);

The model contains a Sum of Elements block and the input of the block is an array. By default,
Simulink configures a model with column-major algorithms and column-major array layout. In this
example, you configure the array layout of this model as row-major. To specify the array layout, open
the Embedded Coder app, and then open the Configuration Parameters dialog box. On the Code
Generation > Interface pane, set the configuration parameter Array layout to Row-Major option.
Alternatively, in the MATLAB Command Window, enter:

set_param(model,'ArrayLayout','Row-major');

Change your current folder in MATLAB to a writable folder. Then generate code from the model by
using the slbuild function or by pressing Ctrl+B.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
% Generate code and capture the code generation information to Value
Value=evalc('slbuild(''ex_rowmajor_algorithm'')');

Inspect the generated ex_rowmajor_algorithm_step step function in the
ex_rowmajor_algorithm.c.

file = fullfile('ex_rowmajor_algorithm_ert_rtw','ex_rowmajor_algorithm.c');
rtwdemodbtype(file,'/* Model step function */','/* Model initialize function',1,1);
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/* Model step function */
void ex_rowmajor_algorithm_step(void)
{
  int32_T i;
  int32_T i_0;
  int32_T tmp;

  /* Sum: '<Root>/Sum of Elements Dim1' incorporates:
   *  Constant: '<Root>/Constant1'
   */
  ex_rowmajor_algorithm_Y.Out2 = -0.0F;
  for (i = 0; i < 2; i++) {
    for (i_0 = 0; i_0 < 3; i_0++) {
      tmp = (i_0 << 1) + i;
      ex_rowmajor_algorithm_Y.Out2 =
        (((ex_rowmajor_algorithm_ConstP.Constant1_Value[tmp] +
           ex_rowmajor_algorithm_Y.Out2) +
          ex_rowmajor_algorithm_ConstP.Constant1_Value[tmp + 6]) +
         ex_rowmajor_algorithm_ConstP.Constant1_Value[tmp + 12]) +
        ex_rowmajor_algorithm_ConstP.Constant1_Value[tmp + 18];
    }
  }

  /* End of Sum: '<Root>/Sum of Elements Dim1' */
}

When Array layout is set to Row-major and the Use algorithms optimized for row-major array
layout configuration parameter is set to off, the code generator uses column-major algorithms. The
algorithms traverse the data in column-major order though the data is in row-major order. This
process requires some extra operations in the generated code, which makes the code less efficient
but at the same time results in higher accuracy of numeric results. If you need higher accuracy of
numeric results where less efficient code is not a concern, it is recommended that you use the
column-major algorithms for row-major array layout.

Generate Code by Using the Row-Major Algorithms for Row-Major Array Layout

To enable the row-major algorithms, on the Math & Data Types pane, select the configuration
parameter “Use algorithms optimized for row-major array layout” check box. This parameter enables
the algorithms that are optimized for row-major array layout. Alternatively, in the MATLAB Command
Window, enter:

set_param(model,'UseRowMajorAlgorithm','on');

After enabling the row-major algorithms, generate code.

Value=evalc('slbuild(''ex_rowmajor_algorithm'')');

Inspect the generated ex_rowmajor_algorithm_step step function in the
ex_rowmajor_algorithm.c.

file = fullfile('ex_rowmajor_algorithm_ert_rtw','ex_rowmajor_algorithm.c');
rtwdemodbtype(file,'/* Model step function */','/* Model initialize function',1,1);

/* Model step function */
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void ex_rowmajor_algorithm_step(void)
{
  int32_T i;

  /* Sum: '<Root>/Sum of Elements Dim1' incorporates:
   *  Constant: '<Root>/Constant1'
   */
  ex_rowmajor_algorithm_Y.Out2 = -0.0F;
  for (i = 0; i < 24; i++) {
    ex_rowmajor_algorithm_Y.Out2 +=
      ex_rowmajor_algorithm_ConstP.Constant1_Value[i];
  }

  /* End of Sum: '<Root>/Sum of Elements Dim1' */
}

In comparison to the previous code, when the Array layout is set to Row-major and the Use
algorithms optimized for row-major array layout configuration parameter is set to on, the code
generator generates efficient code. The code generator uses row-major algorithms that traverse the
data in row-major order, which reduces the number of operations in the generated code. But the
accuracy of numeric results might not be as high as the previous example. So, you might experience
minor numeric differences in the output of column-major and row-major algorithms. If you need an
efficient code where numeric accuracy is not a concern, it is recommended that you use the row-
major algorithms for row-major array layout.

See Also

Related Examples
• “Code Generation of Matrices and Arrays” on page 50-60
• “Interpolation Algorithm for Row-Major Array Layout” on page 44-9
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Generate Row-Major Code for Model That Contains a MATLAB
Function Block

Programming languages and environments assume a single array layout for all data. MATLAB and
Fortran use column-major layout by default, whereas C and C++ use row-major layout. With Simulink
Coder, you can generate C/C++ code that uses row-major layout or column-major layout.

To learn more about row-major code generation, see “Code Generation of Matrices and Arrays” on
page 50-60.

MATLAB Function blocks enable you to define custom functionality in Simulink models by using the
MATLAB language. You can generate row-major code for models that contain a MATLAB Function
block by using row-major or column-major data. For more information on MATLAB Function blocks,
see “Implementing MATLAB Functions Using Blocks”.

By default, the code generator generates column-major code. For C/C++ code generation, you can
specify the array layout at the model level by using the Array layout model configuration parameter.
Setting this parameter to Row-major enables the model for row-major code generation. To enable
the MATLAB Function block in your model for row-major code generation, use the coder.rowMajor
function at the function level inside the block.

Row-Major Code Generation
For certain algorithms, row-major layout provides more efficient memory access. You get efficient
code when you generate code for a model that uses row-major array layout and the model contains a
MATLAB Function block that uses an algorithm for row-major data.

1 Consider an example model ex_row_major_MLFB.

This model contains a Constant block that has a [5 4] matrix. To specify the matrix, set
Constant value to:

reshape(1:20,5,4)

The Inport block also specifies a [5 4] matrix. To specify the matrix, set the Port dimensions
to [5 4].

2 In the Configuration Parameters dialog box, set Array layout to Row-major.
3 Write a function for matrix addition called addMatrix. The MATLAB Function block inherits the

array layout setting from the model configuration parameter Array layout unless specified
otherwise.
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Optionally, you can use coder.rowMajor to explicitly set the array layout of the MATLAB
Function block to row-major layout.

function S  = addMatrix(A,B) 
S = zeros(size(A));
for row = 1:size(A,1) 
   for col = 1:size(A,2)  
       S(row,col) = A(row,col) + B(row,col);
   end
end

4 Generate code for the model. From the C Code tab, click Build.

The code generator produces this C code:

for (b_row = 0; b_row < 5; b_row++) {
    for (b_col = 0; b_col < 4; b_col++) {
      rtb_S_tmp = (b_row << 2) + b_col;
      rtb_S[rtb_S_tmp] = ex_row_major_MLFB_P.Constant_Value[rtb_S_tmp] +
        ex_row_major_MLFB_U.Inport1[rtb_S_tmp];
    }
  }

The generated code has two for loops. The first for loop accesses the rows and the second for loop
accesses the columns. When the array layout of the MATLAB Function block and the model is the
same, the generated code is efficient because no transposes or conversion are required.

Mixed-Majority Code Generation
You can generate mixed-majority code when you have a model that operates on row-major data and a
MATLAB Function block that operates on column-major data. When you generate code for a model
that uses column-major layout, and the model contains a MATLAB Function block that uses row-major
layout, then the code generator converts the block input data to row-major and the block output data
back to column-major data, as needed. You can also generate mixed majority code when you have a
model that operates on column-major data and a MATLAB Function block that operates on row-major
data.

Array layout conversions can affect performance.

1 Consider the example model ex_row_major_MLFB. For more information on the example model,
see “Row-Major Code Generation” on page 44-34.

In the Configuration Parameters dialog box, set Array layout to Row-major.
2 Update the addMatrix function in the MATLAB Function block for column-major data by using

the coder.columnMajor function.

function S  = addMatrix(A,B) 
coder.columnMajor;
S = zeros(size(A));
for row = 1:size(A,1) 
   for col = 1:size(A,2)  
       S(row,col) = A(row,col) + B(row,col);
   end
end
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You can generate mixed-majority code by using the MATLAB Function block. In this case, you
configure the model for row-major array layout and the MATLAB Function block for column-
major array layout.

3 Generate code for the model. From the C Code tab, click Build.

The code generator produces this C code:
for (b_row = 0; b_row < 4; b_row++) {
    for (b_col = 0; b_col < 5; b_col++) {
      B_tmp = (b_col << 2) + b_row;
      B_tmp_0 = b_col + 5 * b_row;
      B[B_tmp_0] = ex_row_major_MLFB_19b_U.Inport1[B_tmp];
      A[B_tmp_0] = ex_row_major_MLFB_19b_P.Constant_Value[B_tmp];
    }
  }

  for (b_row = 0; b_row < 5; b_row++) {
    /* Outport: '<Root>/Outport' */
    for (b_col = 0; b_col < 4; b_col++) {
      B_tmp = 5 * b_col + b_row;
      ex_row_major_MLFB_19b_Y.Outport[b_col + (b_row << 2)] = A[B_tmp] + B[B_tmp];
    }

The inputs to the MATLAB Function block exist in a row-major environment. The code generator
performs a conversion operation on inputs before they are fed to the MATLAB Function block because
the block is column-major layout. After processing the algorithm in the MATLAB Function block, the
code generator converts the data back to row-major data before passing the data to an Outport.

See Also

Related Examples
• “Interface with Row-Major Data in MATLAB Function Block”
• “Specify Array Layout in Functions and Classes”
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Preserve Dimensions

• “Preserve Dimensions of Multidimensional Arrays in Generated Code” on page 45-2
• “Preserve Dimensions of Bus Elements in Generated Code” on page 45-7
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Preserve Dimensions of Multidimensional Arrays in Generated
Code

By default, the generated code contains one-dimensional arrays for multidimensional model data. In
the Configuration Parameters dialog box, if you set the Array layout parameter to Row-major, you
can preserve dimensions of multidimensional arrays in the generated code. Preserving array
dimensions in the generated code enhances integration with external code.

MATLAB and C organize multidimensional data in different ways. For more details, see “Dimension
Preservation of Multidimensional Arrays” on page 33-109.

In the generated code, you can preserve dimensions of root-level inports and outports, parameters,
signals, states, lookup tables, and data stores.

Configure Default Model Data Elements to Preserve Dimensions
In the Code Mappings > Data Defaults tab, you can configure these model data elements
categories. You specify a storage class to preserve dimensions.

• Inports
• Outports
• Signals, states, and internal data
• Shared local data stores
• Global data stores
• Model parameters
• External parameters

Then, when you set the Storage class to Auto or Model default on individual model data
elements, by default, the code generator applies the configuration that you set up for the respective
model data elements in the Data Defaults tab.

An example workflow that is applicable to the preceding model data element categories is:

1 Open the model rtwdemo_preservedimensions.
2 In the Configuration Parameters dialog box, verify that parameter Array layout is set to Row-

major.
3 Open the Embedded Coder app.
4 In the C Code tab, open the Code Mappings editor. Select Code Interface > Default Code

Mappings. This option pins the Code Mappings editor and the Property Inspector pane.
5 On the Data Defaults tab, select the Inports category. The Storage Class specified is

ExportToFile. In the Property Inspector, in the Code section, select the PreserveDimensions
property.
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To configure the PreserveDimensions property programmatically, use the
coder.mapping.defaults.set function in the MATLAB command window:

coder.mapping.defaults.set('rtwdemo_preservedimensions', 'Inports',...
  'Storageclass', 'ExportToFile',...
  'PreserveDimensions', 'off')

You can create a new storage class in Embedded Coder, and then specify that class to preserve
dimensions. For more details, see “Preserve Dimensions for New Storage Classes” on page 45-
5.

For a list of supported storage classes, see “Storage Classes Supported to Preserve Dimensions”
on page 45-5.

6 Generate and review code. The generated code preserves the dimensions of the root-level
Inports.

real_T rtPressure[2][3];
real_T rtTargetVolume[2][3];
real_T rtTemperature[2][3]; 

Configure Individual Model Data Elements to Preserve Dimensions
You can override the default configurations specified in the Data Defaults tab by configuring
individual model data element sources in other tabs such as Inports, Outports, Parameters, Data
Stores, and Signals/States. Here is an example workflow that is applicable to the model data
element categories.

1 From the C Code tab, open Code Interface > Individual Element Code Mappings.
2 In the Code Mappings editor, select the Signals/States tab. The Signals section is currently

empty. There can be multiple signals in a given model. Some of these signals might not be
important when configuring code generation. You can mark signals as signals of interest that are
relevant to your code generation configuration. When you add a signal explicitly, it gets added to
the Code Mappings editor.

In the Code Mappings editor, open the Signals/States tab. Select the signal in the Simulink
Editor that you want to add to the Code Mappings editor. Pause on the ellipsis (...) that appears
above or below the signal line to open the action bar. Click the Add selected signals to code
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mappings button. The signal is populated in the Signals table in the Code Mappings editor.

For this example, select the signal going from the subsystem Volume Controller to the outport
Actuator Command and click the Add selected signals to code mappings button.

3 As per the configurations in the Data Defaults tab, the default storage class for signals is
Localizable. The default configuration for signals also specifies to preserve dimensions of
multidimensional arrays.

By default the Storage Class of the individually added signal is configured as Auto. You can
override the default configuration for the individual signal by changing the specification of the
added signal under Signals/States tab.

If you want to apply the default settings, set the Storage Class to Model default:
Localizable. If you want to maintain the same storage class, Localizable, but not preserve
dimensions for the selected signal, specify Storage Class as Localizable and clear the
PreserveDimensions property in the Property Inspector.

Note If you specify the Storage Class as Model default, you cannot override the default
configurations specified in Data Defaults tab. To override the default specifications for the
default storage class, select that storage class and change the configurations for the individual
modeling element.

4 In the Property Inspector, specify a signal name in the Identifier property, such as
VolumeController.

5 Generate and review code. The generated code does not preserve dimensions of the individual
signal but does for other signals.
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/* Definition for custom storage class: Localizable */
static real_T LogSignal[11][9];        /* '<S2>/Log volume difference' */
real_T VolumeController[6];            /* '<S3>/Gain' */
static real_T rtIterationCount[2][3];  /* '<S2>/IterationCount' */
static real_T rtIterationCount_g[2][3];/* '<S2>/PreviousVolumeErrorAverage' */
static real_T rtVolumedifference[2][3];/* '<S1>/Volume difference' */

Storage Classes Supported to Preserve Dimensions
You can preserve dimensions in the generated code for these storage classes:

• Const
• Volatile
• ConstVolatile
• ExportToFile
• ImportFromFile
• FileScope
• Localizable

Preserve Dimensions for New Storage Classes
To preserve dimensions when you design your own storage class, in the Embedded Coder Dictionary,
in the Property Inspector, set Storage Type to Unstructured and select the Preserve array
dimensions property. Selecting this property preserves dimensions for instances of your storage
class. To use the storage class, in the Code Mappings editor, configure the model element categories
by specifying Storage Class to the new storage class that you created.

To preserve dimensions when you design your own storage class in the Custom Storage Class
Designer, specify Type as Unstructured and select the Preserve array dimensions property.
Preserve array dimensions has these options:

• No (default) — Flattens the multidimensional array to one dimension in the generated code.
• Yes — Preserves array dimensions for parameters of the specified storage class.
• Instance Specific — If you want to preserve array dimensions for each instance of the storage

class, enable the Preserve array dimensions property on the parameter object. For the Simulink
package, this property setting is Instance Specific by default.

Limitations
• The code generator flattens multidimensional arrays in Simulink buses in the generated code.
• The code generator does not preserve dimensions for parameters without data objects.

See Also
coder.mapping.api.CodeMapping | Embedded Coder Dictionary | Code Mappings editor

Related Examples
• “Code Generation of Matrices and Arrays” on page 50-60
• “Select Array Layout for Matrices in Generated Code” (Stateflow)
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• “Preserve Dimensions of Bus Elements in Generated Code” on page 45-7
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture”

on page 31-2
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Preserve Dimensions of Bus Elements in Generated Code
By default, the generated code contains one-dimensional arrays for multidimensional model data. In
the Configuration Parameters dialog box, if you set the “Array layout” parameter to Row-major, you
can preserve dimensions of multidimensional arrays in the generated code. See “Preserve Dimensions
of Multidimensional Arrays in Generated Code” on page 45-2.

In the generated code, you can preserve dimensions of root-level inports and outports, parameters,
signals, states, lookup tables, and data stores by configuring storage classes in the Embedded Coder
Dictionary and Code Mappings editor. The Preserve array dimensions property that you configure
for storage classes is applicable to data elements in the model. You cannot use the storage class
property to preserve dimensions of bus elements because the bus objects are global types usually
shared between multiple data elements such as states, signals, and so on.

To preserve dimensions of bus objects that contain multidimensional bus elements, use the Preserve
element dimensions property in the Bus Editor. You can preserve dimensions of bus objects for ERT
models only.

Open Example Model

1. Open the model rtwdemo_preservedimensions_slbus.

rtwdemo_preservedimensions_slbus;

2. Open the Embedded Coder app.

3. In the Configuration Parameters dialog box, verify that parameter Array layout is set to Row-
major.

Configure Bus Elements

1. The model includes these Simulink.Bus objects in the base workspace:

• ImperialSpecs
• MetricSpecs

On the Simulink Toolstrip, the Modeling tab, in the Design gallery, click Bus Editor. Alternatively,
at the MATLAB command prompt, enter buseditor.
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2. For the bus object ImperialSpecs, open the Code Generation tab and select Preserve element
dimensions checkbox.

Alternatively, at the MATLAB command prompt, enter:

ImperialSpecs.PreserveElementDimensions = 1;

3. Click Apply and close the Bus Editor dialog box.

Generate and Review Code

Generate code for the model. On the C Code tab, click Build.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
evalc('slbuild(''rtwdemo_preservedimensions_slbus'')');

The generated code preserves the dimensions of the multidimensional bus element. In the
ImperialSpecs bus object, the bus element DimensionsInInches is a multidimensional array of
[10 3] whereas the bus element WeightInPounds is a vector of [10]. The Preserve element
dimensions property is applied for multidimensional arrays.

file = fullfile('rtwdemo_preservedimensions_slbus_ert_rtw',...
    'rtwdemo_preservedimensions_slbus.h');
rtwdemodbtype(file,'#define DEFINED_TYPEDEF_FOR_ImperialSpecs_', ...
    '} ImperialSpecs;',0,1);

typedef struct {
  real_T DimensionsInInches[10][3];
  real_T WeightInPounds[10];
} ImperialSpecs;

See Also

Related Examples
• “Preserve Dimensions of Multidimensional Arrays in Generated Code” on page 45-2
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• “Dimension Preservation of Multidimensional Arrays” on page 33-109
• “Code Generation of Matrices and Arrays” on page 50-60
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Configuration for Simulink Coder

• “Code Generation Configuration” on page 46-2
• “Configure Code Generation Parameters for Model Programmatically” on page 46-4
• “Configure Model from Command Line” on page 46-6
• “Use Configuration Reference to Select Code Generation Target” on page 46-11
• “Check Model and Configuration for Code Generation” on page 46-16
• “Application Objectives Using Code Generation Advisor” on page 46-18
• “Simulink Coder Model Advisor Checks for Standards and Code Efficiency” on page 46-21
• “Configure Code Comments” on page 46-22
• “Include MATLAB Code as Comments in Generated Code” on page 46-23
• “Construction of Generated Identifiers” on page 46-27
• “Identifier Name Collisions and Mangling” on page 46-28
• “Specify Identifier Length to Avoid Naming Collisions” on page 46-29
• “Specify Reserved Names for Generated Identifiers” on page 46-30
• “Reserved Keywords” on page 46-31
• “Configure Model for Debugging” on page 46-34
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Code Generation Configuration
When you are ready to generate code for a model, you can modify the model configuration
parameters specific to code generation. The code generation parameters determine how the code
generator produces code and builds an executable program from your model.

The model configuration parameters for code generation are in the Code Generation and pane in
the Configuration Parameters dialog box. The content of the Code Generation pane and its subpanes
can change depending on the target that you specify. Some configuration options are available only
with the Embedded Coder product.

Your application objectives can include a combination of these code generation objectives: debugging,
traceability, execution efficiency, and safety precaution. There are tradeoffs associated with these
configuration choices, such as execution speed and memory usage. To help configure a model to
achieve your application objectives, use the Model Advisor and the Code Generation Advisor.

Open the Model Configuration for Code Generation
To modify the model configuration parameters for code generation, open the Code Generation pane.
There are several different ways to open the Code Generation pane from the Simulink editor:

• To open the Configuration Parameters dialog box, click the model configuration parameters icon.

Then, click Code Generation in the left pane.
• On the C Code tab, select Settings > Code Generation Settings.
• On the Modeling tab, click Model Explorer, or from the MATLAB command line, type daexplr

and press Enter. In the left pane of the Model Explorer, expand the node for the current model
and click the Configurations node. In the Contents pane, right-click the configuration and select
Open from the context menu. Then click Code Generation in the left pane.

Note In the Configuration Parameters dialog box, when you change the value of a check box, menu
selection, or edit field, the white background of the element changes color to indicate that you made
an unsaved change. When you click OK, Cancel, or Apply, the background resets to white.

Configuration Tools
To help you configure your model for code generation and to check your configuration against your
code generation objectives, Simulink Coder and Embedded Coder provide several tools.

Goal Approach More Information
Automate configuration. At the MATLAB command line,

use the set_param function
“Configure Code Generation
Parameters for Model
Programmatically” on page 46-4

46 Configuration for Simulink Coder

46-2



Goal Approach More Information
Configure your model for
code generation quickly
and easily.

Quick Start tool • “Generate Code by Using the
Quick Start Tool”

• “Generate Code by Using the
Quick Start Tool” on page 51-9

Use a template to create a
model configured for code
generation, ready for you
to add your own blocks.

Code generation templates “Generate Code and Simulate Models
in a Project”

To configure your model
for code generation, use
Simulink blocks and
predefined or custom
MATLAB scripts.

Code Generation Wizards blocks “Configure and Optimize Model with
Configuration Wizard Blocks” on page
47-18

Verify that your model
meets standards and
guidelines.

Model Advisor “Check Your Model Using the Model
Advisor”

Verify that your model
meets your application
objectives.

Code Generation Advisor “Application Objectives Using Code
Generation Advisor” on page 46-18

See Also

Related Examples
• “Model Configuration Sets”
• “Configure Code Generation Parameters for Model Programmatically”
• “Application Objectives Using Code Generation Advisor” on page 46-18
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Configure Code Generation Parameters for Model
Programmatically

You can modify code generation parameters for the active configuration set in the Configuration
Parameters dialog box or from the MATLAB command line. Use the command-line approach for
creating a script that automates setting parameters for an established model configuration.

Modify Parameters to Support Execution efficiency
In this example, you modify the configuration parameters to support the Code Generation Advisor
application objective, Execution efficiency.

Step 1. Open a model.

slexAircraftExample

Step 2. Get the active configuration set.

cs = getActiveConfigSet(model);

Step 3. Select the Generic Real-Time (GRT) target.

switchTarget(cs,'grt.tlc',[]);

Step 4. To optimize execution speed, modify parameters.

If your application objective is Execution efficiency, use set_param to modify these
parameters:

set_param(cs,'MatFileLogging','off');
set_param(cs,'SupportNonFinite','off');
set_param(cs,'RTWCompilerOptimization','on');
set_param(cs,'OptimizeBlockIOStorage','on');
set_param(cs,'EnhancedBackFolding','on');
set_param(cs,'ConditionallyExecuteInputs','on')
set_param(cs,'DefaultParameterBehavior','Inlined');
set_param(cs,'BooleanDataType','on');
set_param(cs,'BlockReduction','on');
set_param(cs,'ExpressionFolding','on');
set_param(cs,'LocalBlockOutputs','on');
set_param(cs,'EfficientFloat2IntCast','on');
set_param(cs,'BufferReuse','on');

Step 5. Save the model configuration to a file.

Save the model configuration to a file, 'Exec_efficiency_cs.m', and view the parameter settings.
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saveAs(cs,'Exec_Efficiency_cs');
dbtype Exec_Efficiency_cs 1:50

See Also

More About
• “Code Generation Configuration” on page 46-2
• “Application Objectives Using Code Generation Advisor” on page 46-18
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Configure Model from Command Line
The code generator provides model configuration parameters for customizing generated code.
Depending on how you use and interact with the generated code, you make configuration decisions.
You choose a configuration that best matches your needs for debugging, traceability, code efficiency,
and safety precaution.

It is common to automate the model configuration process by using a MATLAB® script once you have
decided upon a desired configuration.

The example describes:

• Concepts of working with configuration parameters
• Documentation to understand the code generation options
• Tools and scripts to automate the configuration of a model

Configuration Parameter Workflows

There are many workflows for Configuration Parameters that include persistence within a single
model or persistence across multiple models. Depending on your needs, you can work with
configuration sets as copies or references. This example shows the basics steps for working directly
with the active configuration set of a model. For a comprehensive description of configuration set
features and workflows, see Configuration Sets in the Simulink® documentation.

Configuration Set Basics

Load a model into memory.

model='rtwdemo_configwizard';
load_system(model)

Obtain the model's active configuration set.

cs = getActiveConfigSet(model);

Simulink® Coder™ exposes a subset of the code generation options. If you are using Simulink®
Coder™, select the Generic Real-Time (GRT) target.

switchTarget(cs,'grt.tlc',[]);

Embedded Coder® exposes the complete set of code generation options. If you are using Embedded
Coder®, select the Embedded Real-Time (ERT) target.

switchTarget(cs,'ert.tlc',[]);

To automate configuration of models built for GRT- and ERT-based targets, the configuration set
IsERTTarget attribute is useful.

isERT = strcmp(get_param(cs,'IsERTTarget'),'on');

You can interact with code generation options via the model or the configuration set. This example
gets and sets options indirectly via the model.

deftParamBehvr = get_param(model,'DefaultParameterBehavior');  % Get
set_param(model,'DefaultParameterBehavior',deftParamBehvr)     % Set
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This example gets and sets options directly via the configuration set.

if isERT
    lifespan = get_param(cs,'LifeSpan');  % Get LifeSpan
    set_param(cs,'LifeSpan',lifespan)     % Set LifeSpan
end

Configuration Option Summary

The full list of code generation options are documented with tradeoffs for debugging, traceability,
code efficiency, and safety precaution.

• Simulink® Coder™ options
• Embedded Coder® options

Use Code Generation Advisor to obtain a model configuration optimized for your goals. In the Set
Objectives dialog box, you can set and prioritize objectives.

You can find documentation about the Code Generation Advisor in the Simulink Coder documentation
and additional documentation specific to Embedded Coder®.

Parameter Configuration Scripts

Simulink® Coder™ provides an example configuration script that you can use as a starting point for
your application. A list of the most relevant GRT and ERT code generation options are contained in
rtwconfiguremodel.m.

Alternatively, you can generate a MATLAB function that contains the complete list of model
configuration parameters by using the configuration set saveAs function.

% Go to a temporary writable directory.
currentDir = pwd;
rtwdemodir();

% Save the model's configuration parameters to file 'MyConfig.m'.
saveAs(cs,'MyConfig')

% Display the first 50 lines of MyConfig.m.
dbtype MyConfig 1:50

1     function cs = MyConfig()
2     % MATLAB function for configuration set generated on 25-Feb-2021 13:16:58
3     % MATLAB version: 9.10.0.1602886 (R2021a)
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4     
5     cs = Simulink.ConfigSet;
6     
7     % Original configuration set version: 21.0.0
8     if cs.versionCompare('21.0.0') < 0
9         error('Simulink:MFileVersionViolation', 'The version of the target configuration set is older than the original configuration set.');
10    end
11    
12    % Character encoding: UTF-8
13    
14    % Do not change the order of the following commands. There are dependencies between the parameters.
15    cs.set_param('Name', 'Configuration'); % Name
16    cs.set_param('Description', ''); % Description
17    
18    % Original configuration set target is ert.tlc
19    cs.switchTarget('ert.tlc','');
20    
21    cs.set_param('HardwareBoard', 'None');   % Hardware board
22    
23    cs.set_param('TargetLang', 'C');   % Language
24    
25    cs.set_param('CodeInterfacePackaging', 'Nonreusable function');   % Code interface packaging
26    
27    cs.set_param('GenerateAllocFcn', 'off');   % Use dynamic memory allocation for model initialization
28    
29    cs.set_param('Solver', 'FixedStepDiscrete');   % Solver
30    
31    % Solver
32    cs.set_param('StartTime', '0.0');   % Start time
33    cs.set_param('StopTime', '48');   % Stop time
34    cs.set_param('SampleTimeConstraint', 'STIndependent');   % Periodic sample time constraint
35    cs.set_param('SolverType', 'Fixed-step');   % Type
36    cs.set_param('ConcurrentTasks', 'off');   % Allow tasks to execute concurrently on target
37    
38    % Data Import/Export
39    cs.set_param('Decimation', '1');   % Decimation
40    cs.set_param('LoadExternalInput', 'off');   % Load external input
41    cs.set_param('SaveFinalState', 'off');   % Save final state
42    cs.set_param('LoadInitialState', 'off');   % Load initial state
43    cs.set_param('LimitDataPoints', 'off');   % Limit data points
44    cs.set_param('SaveFormat', 'StructureWithTime');   % Format
45    cs.set_param('SaveOutput', 'off');   % Save output
46    cs.set_param('SaveState', 'off');   % Save states
47    cs.set_param('SignalLogging', 'on');   % Signal logging
48    cs.set_param('DSMLogging', 'on');   % Data stores
49    cs.set_param('InspectSignalLogs', 'off');   % Record logged workspace data in Simulation Data Inspector
50    cs.set_param('SaveTime', 'off');   % Save time

Each parameter setting in the generated file includes a comment for the corresponding parameter
string in the Configuration Parameters dialog box.

% Return to previous working directory.
cd(currentDir)

Configuration Wizard Blocks

Embedded Coder® provides a set of Configuration Wizard blocks to obtain an initial configuration of
a model for a specific goal. The predefined blocks provide configuration for:
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• ERT optimized for fixed point
• ERT optimized for floating point
• GRT optimized for fixed and floating point
• GRT debug settings for fixed and floating point
• Custom (you provide the script)

Put the block into a model and double-click it to configure the model. Open model
rtwdemo_configwizard and click Open Configuration Wizard Library to interact with the blocks.

open_system(model)

To use configuration wizard blocks in the rtwdemo_configwizard model follow these steps:

• Open the Configuration Wizard Library by clicking the link provided in the model.
• Open the Model's Configuration Parameters by clicking the link provided in the model.
• Drag and drop a Configuration Wizard Block, for example ERT (optimized for fixed point), from the

wizard library into the model.
• Double-click the wizard block.

The Configuration Parameter options are modified automatically.

% cleanup
rtwdemoclean;
close_system(model,0)

Summary

Simulink provides a rich set of MATLAB functions to automate the configuring a model for simulation
and code generation. Simulink Coder and Embedded Coder® provide additional functionality specific
for code generation. The Code Generation Advisor optimizes the model configuration based on a set
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of prioritized goals. You can save the optimal configuration to a MATLAB file by using the
configuration set saveAs function, and reuse it across models and projects.

See Also

More About
• “Code Generation Configuration” on page 46-2
• “Application Objectives Using Code Generation Advisor” on page 46-18
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Use Configuration Reference to Select Code Generation Target
This example shows how to use a configuration reference to select a code generation target for a
model reference hierarchy without modifying individual models.

Open Example Model

Open the example model slexConfigSetRefExample.

open_system('slexConfigSetRefExample');

To open the active configuration set for the model slexConfigSetRefExample, on the Modeling
tab, click the Model Configuration Parameters button.
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Because the model is using a referenced configuration, the Configuration Reference dialog box opens
and displays a read-only view of the referenced configuration set. Information at the top of the dialog
box indicates that the model is using the configuration set, Reference, located in the data dictionary,
slexConfigSetRefData.sldd. In this example, Reference is another configuration reference,
Configuration_ERT.

In the model editor, right-click the Model block, Amplifier, and select Open As Top Model.

open_system('slexConfigSetRefExample/Amplifier');

Open the active configuration set for this model. The name and location for the referenced
configuration is the same as in slexConfigSetRefExample.
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Open the Referenced Configuration Set

If you need to change and apply parameter values in the configuration set, open
Configuration_ERT for edit in the Configuration Parameters dialog box by clicking the Model
Configuration Parameters icon at the top of either of the Configuration Reference dialog boxes.
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Generate Code for ERT Target

The referenced configuration set is customized for ERT code generation. To generate code, press Ctrl
+B.

slbuild('slexConfigSetRefExample');

### Starting serial model reference code generation build
### Starting build procedure for: slexConfigSetRefMdlRef
### Successful completion of code generation for: slexConfigSetRefMdlRef
### Starting build procedure for: slexConfigSetRefExample
### Successful completion of code generation for: slexConfigSetRefExample

Build Summary

Code generation targets built:

Model                   Action          Rebuild Reason                            
==================================================================================
slexConfigSetRefMdlRef  Code generated  slexConfigSetRefMdlRef.c does not exist.  

Top model targets built:
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Model                    Action          Rebuild Reason                                    
===========================================================================================
slexConfigSetRefExample  Code generated  Code generation information file does not exist.  

2 of 2 models built (0 models already up to date)
Build duration: 0h 0m 22.632s

The code generation report displays once code generation is complete.

Switch Targets and Generate Code for AUTOSAR Target

For this model there is another configuration set, Configuration_AUTOSAR, that is customized for
AUTOSAR code generation. At the top of the Configuration Reference dialog box, in the rightmost
drop-down list, select Configuration_AUTOSAR. slexConfigSetREfExample and its referenced
model, slexConfigSetMdlRef, now both use the configuration set, Configuration_AUTOSAR.

Because you edited the configuration reference, the data dictionary has unsaved changes. The
configurations are stored outside of the models so the models do not have unsaved changes.

If you have downloaded the AUTOSAR package, you can now generate code for an AUTOSAR target.
In the model editor window, press Ctrl+B.
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Check Model and Configuration for Code Generation
You can use the Model Advisor checks to assess model readiness to generate code. To check and
configure your model for code generation application objectives such as traceability or debugging,
use the Code Generation Advisor.

For information about See
Model Advisor “Run Model Advisor Checks”
Code Generation Advisor “Application Objectives Using Code Generation

Advisor”
Checks available with Simulink Coder “Simulink Coder Checks”
Checks available with Embedded Coder “Embedded Coder Checks”

Check Mode for Code Efficiency with Model Advisor
To check model rtwdemo_throttlecntrl for code efficiency, use the Model Advisor.

1 Open rtwdemo_throttlecntrl. Save a copy as throttlecntrl in a writable location on your
MATLAB path.

2 To start the Model Advisor, on the Modeling tab, click Model Advisor. A dialog box opens
showing the model system hierarchy.

3 Click throttlecntrl and then click OK. The Model Advisor window opens.
4 Expand By Task > Code Generation Efficiency. To check your model for code generation

efficiency, use the checks in the folder. By default, checks that do not trigger an Update Diagram
are selected. The checks available for code generation efficiency depend on whether you have a
Simulink Coder or Embedded Coder license.

5 In the left pane, select the remaining checks, and then select Code Generation Efficiency.
6 In the right pane, select Show report after run and click Run Selected Checks. The report

shows a Run Summary that flags check warnings.
7 Review the report. The warnings highlight issues that impact code efficiency. For more

information about the report, see “View Model Advisor Check Reports”.

Check Model During Code Generation with Code Generation Advisor
To review a model as part of the code generation process, use the Code Generation Advisor.

1 To specify your code generation objectives, on the Configuration Parameters > Code
Generation pane, choose a value for the Select objective parameter.

2 Select one of the following values for the parameter Check model before generating code:

• On (proceed with warnings)
• On (stop for warnings)

3 If you want to only generate code, select Generate code only. Otherwise clear the check box to
build an executable.

4 Apply your changes, and press Ctrl+B to generate code. The Code Generation Advisor starts and
reviews the top model and subsystems.
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If the Code Generation Advisor issues failures or warnings, and you specified:

• On (proceed with warnings) — The Code Generation Advisor window opens while the
build process proceeds. After the build process is complete, you can review the results.

• On (stop for warnings) — The build process halts and displays the Diagnostic Viewer. To
continue, you must review and resolve the Code Generation Advisor results or clear the
Check model before generating code parameter.

5 In the Code Generation Advisor dialog box, review the results by selecting a check from the left
pane. The results for that check display in the right pane.

6 After reviewing the check results, you can choose to fix warnings and failures as described in
“Fix a Model Advisor Check Warning or Failure”.

Note When you specify an efficiency or Safety precaution objective, the Code Generation
Advisor includes additional checks. When you make changes to one of these additional checks,
previous check results can potentially become invalid and need to be rerun.

For more information, see “Set Objectives — Code Generation Advisor Dialog Box”

See Also

Related Examples
• “Check Your Model Using the Model Advisor”
• “Application Objectives Using Code Generation Advisor” on page 46-18

 Check Model and Configuration for Code Generation

46-17



Application Objectives Using Code Generation Advisor
In this section...
“High-Level Code Generation Objectives” on page 46-18
“Configure Model for Code Generation Objectives Using Code Generation Advisor” on page 46-19
“Configure Model for Code Generation Objectives by Using Configuration Parameters Dialog Box” on
page 46-19

Consider how your application objectives, such as efficiency or debugging, map to code generation
options in a model configuration set. Parameters that you set in the Configuration Parameters dialog
box specify the behavior of a model in simulation and the code generated for the model.

Before generating code, or as part of the code generation process, you can use the Code Generation
Advisor to review a model. When you choose to review a model before generating code, you specify
which model, subsystem, or referenced model the Code Generation Advisor reviews. When you
choose to review a model as part of the code generation process, the Code Generation Advisor
reviews the entire system. The Code Generation Advisor uses the information presented in
“Recommended Settings Summary for Model Configuration Parameters” to determine the parameter
values that meet your objectives. To configure objectives for a model with an ERT-based target, see
“Configure Model for Code Generation Objectives Using Code Generation Advisor” on page 46-19.

Setting a code generation objective, and then running the Code Generation Advisor provides
information on how to meet the code generation objective for your model. The Code Generation
Advisor does not alter the generated code. You can use the Code Generation Advisor to make the
suggested changes to your model. The generated code is changed only after you modify your model
and regenerate code. When you use the Code Generation Advisor to set the code generation objective
and check your model, the generated code includes comments identifying which objective you
specified, the checks the Code Generation Advisor ran on the model, and the results of running the
checks.

If a model uses a configuration reference, you can run the Code Generation Advisor to review your
configuration parameter settings. However, the Code Generation Advisor cannot modify the
configuration parameter settings.

High-Level Code Generation Objectives
Depending on the type of application that your model represents, you are likely to have specific high-
level code generation objectives. For example, debugging might be more critical than efficient
execution. If you have a specific objective, you can quickly configure your model to meet that
objective by selecting from these code generation objectives:

• Execution efficiency — Configure code generation settings to achieve fast execution time.
• Debugging — Configure code generation settings to debug the code generation build process.

For a list of objectives that are available for models with ERT-based targets, see “High-Level Code
Generation Objectives” on page 47-2.
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Configure Model for Code Generation Objectives Using Code
Generation Advisor
This example shows how to use the Code Generation Advisor to check and configure your model to
meet code generation objectives:

1 On the C Code tab, click C/C++ Code Advisor.
2 In the System Selector window, select the model or subsystem that you want to review, and then

click OK.
3 In the Code Generation Advisor, on the Code Generation Objectives pane, select a code

generation objective from the drop-down list (GRT-based targets). As you select objectives, on the
left pane, the Code Generation Advisor updates the list of checks it will run on your model. If
your model is configured with an ERT-based target, more objectives are available.

4 Click Run Selected Checks to run the checks listed in the left pane of the Code Generation
Advisor.

5 In the Code Generation Advisor window, review the results for Check model configuration
settings against code generation objectives by selecting it from the left pane. The results for
that check are displayed in the right pane.

Check model configuration settings against code generation objectives triggers a warning
for these issues:

• Parameters are set to values other than the value recommended for the specified code
generation objective.

• The selected code generation objective differs from the objective set in the model.

Click Modify Parameters to set:

• Parameters to the value recommended for the specified code generation objective.
• Code generation objective in the model to the objective specified in the Code Generation

Advisor.
6 In the Code Generation Advisor window, review the results for the remaining checks by selecting

them from the left pane. The results for the checks display in the right pane.
7 After reviewing the check results, you can choose to fix warnings and failures, as described in

“Fix a Model Advisor Check Warning or Failure”.

When you specify a the execution efficiency objective, the Code Generation Advisor includes
additional checks. When you make changes to one of these additional checks, previous check results
can potentially become invalid and need to be rerun.

Configure Model for Code Generation Objectives by Using
Configuration Parameters Dialog Box
This example shows how to check and configure the code generation objectives in the Configuration
Parameters dialog box:

1 Open the Configuration Parameters dialog box and select Code Generation.
2 Select or confirm selection of a System target file.
3 Specify the objective using the Select objectives drop-down list.
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4 Click Check Model to run the model checks.
5 In the System Selector window, select the model or subsystem that you want to review, and then

click OK. The Code Generation Advisor dialog box opens. The Code Generation Advisor uses the
code generation objective to determine which model checks to run.

6 On the left pane, the Code Generation Advisor lists the checks run on the model and the results.
Click each warning to see the suggestions for changes that you can make to your model to pass
the check.

7 Determine which changes to make to your model. On the right pane of the Code Generation
Advisor, follow the instructions listed for each check to modify the model.
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Simulink Coder Model Advisor Checks for Standards and Code
Efficiency

To check that your model meets standards and is ready to generate code, you can use the Model
Advisor checks available with Simulink Coder.

• On the Modeling tab, click Model Advisor.
• In the Model Advisor window, expand the By Task folder. The folder contains Model Advisor

checks that you can run to help accomplish the task.

For more information about the Model Advisor, see “Run Model Advisor Checks”.

The table summarizes the Simulink Coder Model Advisor checks that are available in the By Task
folders.

By Task folder Model Advisor checks
Code
Generation
Efficiency

“Identify blocks using one-based indexing”

Modeling
Standards for
DO-178C/
DO-331

“Check solver for code generation”

“Check for blocks that have constraints on tunable parameters”

“Check sample times and tasking mode”
Model
Referencing

“Check for model reference configuration mismatch”

“Check for code generation identifier formats used for model reference”

See Also

Related Examples
• “Check Your Model Using the Model Advisor”
• “Embedded Coder Model Advisor Checks for Standards, Guidelines, and Code Efficiency” on

page 47-10
• “Modeling Guidelines for Model Configuration”
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Configure Code Comments
Configure how the code generator inserts comments into generated code by modifying parameters on
the Code Generation > Comments pane.

Goal Action
Include comments in
generated code

Include comments. Selecting this parameter allows you to select one or more
autogenerated comment types to be placed in the code.

Include comments that
describe a Simulink
block's code

Simulink block comments. Selecting this parameter includes the comments
before the Simulink block’s code in the generated code. In Embedded Coder, use
Trace to model using to select Block path or Simulink identifier as the
comment format.

Include comments that
describe Stateflow
objects

Stateflow object comments. Selecting this parameter includes the comments
describing Stateflowobjects in the generated code. In Embedded Coder, use Trace
to model using to select Block path or Simulink identifier as the comment
format.

Include MATLAB source
code as comments

MATLAB source code as comments. Selecting this parameter inserts these
comments preceding the associated generated code. The function signature is
included in the function banner.

Include comments for
eliminated blocks

Show eliminated blocks. Selecting this parameter includes comments for blocks
that were eliminated as the result of optimizations, such as inlining parameters.

Include parameter
comments regardless of
the number of
parameters

Verbose comments for 'Model default' storage class. Selecting this parameter
includes comments for parameter variable names and names of source blocks in the
model parameter structure declaration in model_prm.h.

If you do not select this parameter, parameter comments are generated if less than
1000 parameters are declared. This reduces the size of the generated file for models
with a large number of parameters.

Include MATLAB user
comments

MATLAB user comments. Selecting this parameter includes function description
comments and other user comments from MATLAB code as comments in the
generated code.

Specify comment style Comment style. Select Auto, Multi-line or Single-line as the style of
comments in the generated code.

Note When you configure the code generator to produce code that includes comments, the code
generator includes text for model parameters, block names, signal names, and Stateflow object
names in the generated code comments. If the text includes characters that are unrepresented in the
character set encoding for the model, the code generator replaces the characters with XML escape
sequences. For example, the code generator replaces the Japanese full-width Katakana letter ア with
the escape sequence &#x30A2;. For more information, see “Internationalization and Code
Generation”.

See Also

More About
• “Model Configuration Parameters: Comments”
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Include MATLAB Code as Comments in Generated Code
If you have Simulink Coder , you can include MATLAB source code as comments in the code
generated for a MATLAB Function block. Including this information in the generated code enables
you to:

• Correlate the generated code with your source code.
• Understand how the generated code implements your algorithm.
• Evaluate the quality of the generated code.

When you select the MATLAB source code as comments parameter, the generated code includes:

• The source code as a comment immediately after the traceability tag. When you enable
traceability and generate code for ERT targets (requires Embedded Coder), the traceability tags
are hyperlinks to the source code. For more information, see “Use Traceability in MATLAB
Function Blocks” on page 77-35.

For examples and information on the location of the comments in the generated code, see
“Location of Comments in Generated Code” on page 46-23.

• The function help text in the function body in the generated code. The function help text is the
first comment after the MATLAB function signature. It provides information about the capabilities
of the function and how to use it.

Note With Embedded Coder, you can also include the function help text in the generated code
function banner. For more information, see “Include MATLAB User Comments in Generated Code”
on page 46-25.

Include MATLAB Code as Comments in the Generated Code
To include MATLAB source code as comments in the code generated for a MATLAB Function block:

1 On the C Code tab, click Configuration Parameters.
2 In the Code Generation > Comments pane, select MATLAB source code as comments and

click Apply.

Location of Comments in Generated Code
The comments containing the source code appear after the traceability tag in the generated code as
follows.

/* '<S2>:1:18' for y = 1 : 2 : (HEIGHT-4) */

Selecting the Stateflow object comments parameter generates the traceability comment
'<S2>:1:18'. Selecting the MATLAB source code as comments parameter generates the for y
= 1 : 2 : (HEIGHT-4) comment.

Straight-Line Source Code

The comment containing the source code precedes the generated code that implements the source
code statement. This comment appears after comments that you add, which precede the generated
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code. The comments are separated from the generated code because the statements are assigned to
function outputs.

MATLAB Code

function [x y] = straightline(r,theta)
%#codegen
% Convert polar to Cartesian
x = r * cos(theta);
y = r * sin(theta);

Commented C Code

/* MATLAB Function 'straightline': '<S1>:1' */
        /*  Convert polar to Cartesian */
        /* '<S1>:1:4' x = r * cos(theta); */
        /* '<S1>:1:5' y = r * sin(theta); */
        straightline0_Y.x = straightline0_U.r * cos(straightline0_U.theta);
      
        /* Outport: '<Root>/y' incorporates:
         *  Inport: '<Root>/r'
         *  Inport: '<Root>/theta'
         *  MATLAB Function Block: '<Root>/straightline'
         */
        straightline0_Y.y = straightline0_U.r * sin(straightline0_U.theta);

If Statements

The comment for the if statement immediately precedes the code that implements the statement.
This comment appears after comments that you add, which precede the generated code. The
comments for the elseif and else clauses appear immediately after the code that implements the
clause and before the code generated for statements in the clause.

MATLAB Code

function y = ifstmt(u,v) 
%#codegen
if u > v
    y = v + 10;
elseif u == v
    y = u * 2;
else
    y = v - 10;
end

Commented C Code

/* MATLAB Function 'MLFcn': '<S1>:1' */
        /* '<S1>:1:3' if u > v */
        if (MLFcn_U.u > MLFcn_U.v) {
          /* Outport: '<Root>/y' */
          /* '<S1>:1:4' y = v + 10; */
          MLFcn_Y.y = MLFcn_U.v + 10.0;
        } else if (MLFcn_U.u == MLFcn_U.v) {
          /* Outport: '<Root>/y' */
          /* '<S1>:1:5' elseif u == v */
          /* '<S1>:1:6' y = u * 2; */
          MLFcn_Y.y = MLFcn_U.u * 2.0;
        } else {
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          /* Outport: '<Root>/y' */
          /* '<S1>:1:7' else */
          /* '<S1>:1:8' y = v - 10; */
          MLFcn_Y.y = MLFcn_U.v - 10.0;

For Statements

The comment for the for statement header immediately precedes the generated code, which
implements the header. This comment appears after comments that you add, which precede the
generated code.

MATLAB Code

function y = forstmt(u) 
%#codegen
y = 0;
for i=1:u
    y = y + 1;
end

Commented C Code

/* MATLAB Function 'MLFcn': '<S1>:1' */
        /* '<S1>:1:3' y = 0; */
        rtb_y = 0.0;
      
        /* '<S1>:1:5' for i=1:u */
        for (i = 1.0; i <= MLFcn_U.u; i++) {
          /* '<S1>:1:6' y = y + 1; */
          rtb_y++;

While Statements

The comment for the while statement header immediately precedes the generated code, which
implements the statement header. This comment appears after comments that you add, which
precede the generated code.

Switch Statements

The comment for the switch statement header immediately precedes the generated code that
implements the statement header. This comment appears after comments that you add that precede
the generated code. The comments for the case and otherwise clauses appear immediately after
the generated code that implements the clause, and before the code generated for statements in the
clause.

Include MATLAB User Comments in Generated Code
MATLAB user comments include the function help text and other comments. The function help text is
the first comment after the MATLAB function signature. It provides information about the capabilities
of the function and how to use it. You can include the MATLAB user comments in the code generated
for a MATLAB Function block.

1 On the C Code tab, click Configuration Parameters.
2 In the Code Generation > Comments pane, select “MATLAB user comments” and click Apply.
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Limitations of MATLAB Source Code as Comments
For including MATLAB source code as comments, the MATLAB Function block has these limitations :

• You cannot include MATLAB source code as comments for:

• MathWorks toolbox functions
• P-code
• Simulation targets
• Stateflow Truth Table blocks

• The appearance or location of comments can vary depending on these conditions:

• Comments might still appear in the generated code even if the implementation code is
eliminated, for example, due to constant folding.

• Comments might be eliminated from the generated code if a complete function or code block is
eliminated.

• For certain optimizations, the comments might be separated from the generated code.
• The generated code includes legally required comments from the MATLAB source code, even if

you do not choose to include source code comments in the generated code.

See Also

More About
• “Model Configuration Parameters: Comments”
• “Verify Generated Code by Using Code Tracing” on page 77-2
• “Use Traceability in MATLAB Function Blocks” on page 77-35
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Construction of Generated Identifiers
For GRT and RSim targets, the code generator automatically constructs identifiers for variables and
functions in the generated code. These identifiers represent:

• Signals and parameters that have Auto storage class
• Subsystem function names that are not user-defined
• Stateflow names

The components of a generated identifier include

• The root model name, followed by
• The name of the generating object (signal, parameter, state, and so on), followed by
• Unique name-mangling text

The code generator conditionally generates the name-mangling text to resolve potential conflicts with
other generated identifiers.

To configure how the code generator names identifiers and objects, see:

• “Specify Identifier Length to Avoid Naming Collisions” on page 46-29
• “Specify Reserved Names for Generated Identifiers” on page 46-30

The code generator reserves certain words for its own use as keywords of the generated code
language. For more information, see “Reserved Keywords” on page 46-31.

With an Embedded Coder license, you can specify parameters to control identifier formats, mangle
length, scalar inlined parameters, and Simulink data object naming rules. For more information, see
“Customize Generated Identifier Naming Rules” on page 53-10.
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Identifier Name Collisions and Mangling
In identifier generation, a circumstance that would cause generation of two or more identical
identifiers is called a name collision. When a potential name collision exists, unique name-mangling
text is generated and inserted into each of the potentially conflicting identifiers. Each set of name-
mangling characters is unique for each generated identifier.

Identifier Name Collisions with Referenced Models
Referenced models can introduce additional naming constraints. Within a model that uses referenced
models, collisions between the names of the models cannot exist. When you generate code from a
model that includes referenced models, the Maximum identifier length parameter must be large
enough to accommodate the root model name and name-mangling text. A code generation error
occurs if Maximum identifier length is too small.

When a name conflict occurs between an identifier within the scope of a higher-level model and an
identifier within the scope of a referenced model, the identifier from the referenced model is
preserved. Name mangling is performed on the identifier from the higher-level model.

For more information on referenced models, see “Parameterize Instances of a Reusable Referenced
Model”.
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Specify Identifier Length to Avoid Naming Collisions
The length of a generated identifier is limited by the Maximum identifier length parameter
specified on the Identifiers pane of the Configuration Parameters dialog box. The Maximum
identifier length field allows you to limit the number of characters in function, type definition, and
variable names. The default is 31 characters. This is also the minimum length you can specify. The
maximum is 256 characters.

When there is a potential name collision between two identifiers, name-mangling text is generated.
The text has the minimum number of characters required to avoid the collision. The other symbol
components are then inserted. If Maximum identifier length is not large enough to accommodate
full expansions of the other components, they are truncated. To avoid this outcome, it is good practice
to:

• Avoid name collisions by not using default block names (for example, Gain1, Gain2...) when the
model includes multiple blocks of the same type.

• For subsystems, make them atomic and reusable.
• Increase the Maximum identifier length parameter to accommodate the length of the identifier

you expect to generate.
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Specify Reserved Names for Generated Identifiers
You can specify a set of reserved keywords that the code generation process should not use,
facilitating code integration where functions and variables from external environments are unknown
in the Simulink model. To create a list of reserved names, open the Configuration Parameters dialog
box. On the Code Generation > Identifiers pane, enter the keywords in the “Reserved names” field.

If your model contains MATLAB Function or Stateflow blocks, the code generation process can use
the reserved names specified for those blocks if you select Use the same reserved names as
Simulation Target on the Code Generation > Identifiers pane.
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Reserved Keywords
In this section...
“C Reserved Keywords” on page 46-31
“C++ Reserved Keywords” on page 46-31
“Reserved Keywords for Code Generation” on page 46-32
“Code Generation Code Replacement Library Keywords” on page 46-32

Generator keywords are reserved for internal use. Do not use them in models as identifiers or
function names. Also avoid using C reserved keywords in models as identifiers or function names. If
your model contains reserved keywords, code generation does not complete and an error message
appears. To address the error, modify your model to use identifiers or names that are not reserved.

If you use the code generator to produce C++ code, your model must not contain the “Reserved
Keywords for Code Generation” on page 46-32 nor the “C++ Reserved Keywords” on page 46-31.

Note You can register additional reserved identifiers in the Simulink environment. For more
information, see “Specify Reserved Names for Generated Identifiers” on page 46-30.

C Reserved Keywords
auto double int struct
break else long switch
case enum register typedef
char extern return union
const float short unsigned
continue for signed void
default goto sizeof volatile
do if static while

C++ Reserved Keywords
catch friend protected try
class inline public typeid
const_cast mutable reinterpret_cast typename
delete namespace static_cast using
dynamic_cast new template virtual
explicit operator this wchar_t
export private throw  
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Reserved Keywords for Code Generation
abs int8_T MAX_uint8_T* rtInf
asm int16_T MAX_uint16_T* rtMinusInf
bool int32_T MAX_uint32_T* rtNaN
boolean_T int64_T MAX_uint64_T SeedFileBuffer
byte_T INTEGER_CODE MIN_int8_T* SeedFileBufferLen
char_T LINK_DATA_BUFFER_SIZE MIN_int16_T* single
cint8_T LINK_DATA_STREAM MIN_int32_T* TID01EQ
cint16_T localB MIN_int64_T time_T
cint32_T localC MODEL true
creal_T localDWork MT uint_T
creal32_T localP NCSTATES uint8_T
creal64_T localX NULL uint16_T
cuint8_T localXdis NUMST uint32_T
cuint16_T localXdot pointer_T uint64_T
cuint32_T localZCE PROFILING_ENABLED UNUSED_PARAMETER
ERT localZCSV PROFILING_NUM_SAMPLES USE_RTMODEL
false matrix real_T VCAST_FLUSH_DATA
fortran MAX_int8_T* real32_T vector
HAVESTDIO MAX_int16_T* real64_T  
id_t MAX_int32_T* RT  
int_T MAX_int64_T RT_MALLOC  
*Not reserved if you specify a replacement identifier.

Code Generation Code Replacement Library Keywords
The list of code replacement library reserved keywords for your development environment varies
depending on which libraries are registered. The list of available code replacement libraries varies
depending on other installed products (for example, a target product), or if you used Embedded
Coder to create and register custom code replacement libraries.

To generate a list of reserved keywords for libraries currently registered in your environment, use the
following MATLAB function:
lib_ids = RTW.TargetRegistry.getInstance.getTflReservedIdentifiers()

This function returns an array of library keywords. Specifying the input argument is optional.

Note To list the libraries currently registered in your environment, use the MATLAB command
crviewer.
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To generate a list of reserved keywords for a specific library that you are using to generate code, call
the function passing the name of the library as displayed in the Code replacement library menu on
the Code Generation > Interface pane of the Configuration Parameters dialog box. For example,
lib_ids = RTW.TargetRegistry.getInstance.getTflReservedIdentifiers('GNU C99 extensions')

Here is a partial example of the function output:
>> lib_ids = ...
   RTW.TargetRegistry.getInstance.getTflReservedIdentifiers('GNU C99 extensions')

lib_ids = 

    'exp10'
    'exp10f'
    'acosf'
    'acoshf'
    'asinf'
    'asinhf'
    'atanf'
    'atanhf'
...
    'rt_lu_cplx'
    'rt_lu_cplx_sgl'
    'rt_lu_real'
    'rt_lu_real_sgl'
    'rt_mod_boolean'
    'rt_rem_boolean'
    'strcpy'
    'utAssert'

Note Some of the returned keywords appear with the suffix $N, for example, 'rt_atan2$N'. $N
expands into the suffix _snf only if nonfinite numbers are supported. For example, 'rt_atan2$N'
represents 'rt_atan2_snf' if nonfinite numbers are supported and 'rt_atan2' if nonfinite
numbers are not supported. As a precaution, you should treat both forms of the keyword as reserved.
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Configure Model for Debugging
In the Configuration Parameters dialog box, use parameters on the Diagnostics pane and debugging
parameters to configure a model such that the generated code and the build process are set for
debugging. You can set parameters that apply to the model compilation phase, the target language
code generation phase, or both.

Parameters in the following table will be helpful if you are writing TLC code for customizing targets,
integrating legacy code, or developing new blocks.

To... Select...
Display progress
information during code
generation in the MATLAB
Command Window

“Verbose build”.Compiler output also displays.

Prevent the build process
from deleting the
model.rtw file from the
build folder at the end of
the build

“Retain .rtw file”. This parameter is useful if you are modifying the
target files, in which case you need to look at the model.rtw file.

Instruct the TLC profiler to
analyze the performance of
TLC code executed during
code generation and
generate a report

“Profile TLC”. The report is in HTML format and can be read in your
web browser.

Start the TLC debugger
during code generation

“Start TLC debugger when generating code”. Alternatively, enter the
argument -dc for the “System target file” parameter on the Code
Generation pane. To start the debugger and run a debugger script,
enter -df filename for System target file.

Generate a report
containing statistics
indicating how many times
the code generator reads
each line of TLC code
during code generation

“Start TLC coverage when generating code”. Alternatively, enter the
argument -dg for the System Target File parameter on the Code
Generation pane.

Halt a build if a user-
supplied TLC file contains
an %assert directive that
evaluates to FALSE

“Enable TLC assertion”. Alternatively, you can use MATLAB commands
to control TLC assertion handling.

To set the flag on or off, use the set_param command. The default is
off.

set_param(model, 'TLCAssertion', 'on|off') 

To check the current setting, use get_param.

get_param(model, 'TLCAssertion')
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To... Select...
Detect loss of tunability “Detect loss of tunability” on the Diagnostics > Data Validity pane.

You can use this parameter to report loss of tunability when an
expression is reduced to a numeric expression. This can occur if a
tunable workspace variable is modified by Mask Initialization code, or is
used in an arithmetic expression with unsupported operators or
functions. Possible values are:

• none — Loss of tunability can occur without notification.
• warning — Loss of tunability generates a warning (default).
• error — Loss of tunability generates an error.

For a list of supported operators and functions, see “Tunable Expression
Limitations”
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To... Select...
Enable model verification
(assertion) blocks

“Model Verification block enabling”. Use this parameter to enable or
disable model verification blocks such as Assert, Check Static Gap, and
related range check blocks. The diagnostic applies to generated code
and simulation behavior. For example, simulation and code generation
ignore this parameter when model verification blocks are inside an S-
function. Possible values are:

• User local settings
• Enable All
• Disable All

For Assertion blocks not disabled, generated code for a model includes
one of the following statements, depending on the blocks input signal
type (Boolean, real, or integer, respectively).

utAssert(input_signal);
utAssert(input_signal != 0.0);
utAssert(input_signal != 0);

By default, utAssert does not change generated code. For assertions
to abort execution, you must enable them by specifying the following
make_rtw command for Code Generation > “Make command”
parameter:

make_rtw OPTS="-DDOASSERTS"

Use the following variant if you want triggered assertions to print the
assertion statement instead of aborting execution:

make_rtw OPTS="-DDOASSERTS -DPRINT_ASSERTS"

utAssert is defined as #define utAssert(exp) assert(exp).

To customize assertion behavior, provide your own definition of
utAssert in a handwritten header file that overrides the default
utAssert.h. For details on how to include a customized header file in
generated code, see “Integrate External Code by Using Model
Configuration Parameters”.

When running a model in accelerator mode, the Simulink engine calls
back to itself to execute assertion blocks instead of using generated
code. Thus, user-defined callbacks are still called when assertions fail.

For more information about the TLC debugging options, see Debugging on “Target Language
Compiler”. Also, consider using the Model Advisor as a tool for troubleshooting model builds.

See Also

More About
• “Tunable Expression Limitations”
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• “Integrate External Code by Using Model Configuration Parameters”
• “Target Language Compiler”
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Configuration in Embedded Coder

• “Configure Model for Code Generation Objectives by Using Code Generation Advisor”
on page 47-2

• “Configure Code Generation Objectives Programmatically” on page 47-7
• “Check Model and Configuration for Code Generation” on page 47-8
• “Embedded Coder Model Advisor Checks for Standards, Guidelines, and Code Efficiency”

on page 47-10
• “Create Custom Code Generation Objectives” on page 47-13
• “Configuration Variations” on page 47-17
• “Configure and Optimize Model with Configuration Wizard Blocks” on page 47-18
• “Aircraft Position Radar Model” on page 47-25
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Configure Model for Code Generation Objectives by Using Code
Generation Advisor

In this section...
“High-Level Code Generation Objectives” on page 47-2
“Specify Objectives in Referenced Models” on page 47-3
“Configure Model Using Code Generation Advisor” on page 47-3
“Configure Model for Code Generation Objectives by Using Configuration Parameters Dialog Box” on
page 47-5

Consider how your application objectives, such as efficiency, traceability, and safety, map to code
generation parameters in a model configuration set. Parameters that you set in the Configuration
Parameters dialog box specify the behavior of a model in simulation and the code generated for the
model.

Before generating code, or as part of the code generation process, you can use the Code Generation
Advisor to review a model. When you choose to review a model before generating code, you specify
which model, subsystem, or referenced model the Code Generation Advisor reviews. When you
choose to review a model as part of the code generation process, the Code Generation Advisor
reviews the entire system. The Code Generation Advisor uses the information presented in
“Recommended Settings Summary for Model Configuration Parameters” to determine the parameter
values that meet your objectives. When there is a conflict between multiple objectives, the higher-
priority objective takes precedence.

Setting code generation objectives, and then running the Code Generation Advisor provides
information on how to meet code generation objectives for your model. The Code Generation Advisor
does not alter the generated code. You can use the Code Generation Advisor to make the suggested
changes to your model. The generated code is changed only after you modify your model and
regenerate code. When you use the Code Generation Advisor to set code generation objectives and
check your model, the generated code includes comments identifying which objectives you specified,
the checks that the Code Generation Advisor ran on the model, and the results of running the checks.

If a model uses a configuration reference, you can run the Code Generation Advisor to review your
configuration parameter settings. However, the Code Generation Advisor cannot modify the
configuration parameter settings.

High-Level Code Generation Objectives
Depending on the type of application that your model represents, you are likely to have specific high-
level code generation objectives. For example, safety and traceability are more critical than efficient
use of memory. If you have specific objectives, you can quickly configure your model to meet those
objectives by selecting and prioritizing from these code generation objectives:

• Execution efficiency (all targets) — Configure code generation settings to achieve fast execution
time.

• ROM efficiency (ERT-based targets) — Configure code generation settings to reduce ROM usage.
• RAM efficiency (ERT-based targets) — Configure code generation settings to reduce RAM usage.
• Traceability (ERT-based targets) — Configure code generation settings to provide mapping

between model elements and code.
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• Safety precaution (ERT-based targets) — Configure code generation settings to increase clarity,
determinism, robustness, and verifiability of the code.

• Debugging (all targets) — Configure code generation settings to debug the code generation build
process.

• MISRA C:2012 guidelines (ERT-based targets) — Configure code generation settings to increase
compliance with MISRA C:2012 guidelines.

• Polyspace (ERT-based targets) — Configure code generation settings to prepare the code for
Polyspace analysis.

If you select the MISRA C:2012 guidelines code generation objective, the Code Generation Advisor:

• Checks the model configuration settings for compliance with the MISRA C:2012 configuration
setting recommendations.

• Checks for blocks that are not supported or recommended for MISRA C:2012 compliant code
generation.

Specify Objectives in Referenced Models
When you check a model during the code generation process, you must specify the same objectives in
the top model and referenced models. If you specify different objectives for the top model and
referenced model, the build process generates an error.

To specify different objectives for the top model and each referenced model, review the models
separately without generating code.

Configure Model Using Code Generation Advisor
This example shows how to use the Code Generation Advisor to check and configure your model to
meet code generation objectives:

1 On the C Code tab, click C/C++ Code Advisor.
2 In the System Selector window, select the model or subsystem that you want to review, and then

click OK.
3 In the Code Generation Advisor, on the Code Generation Objectives pane, select the code

generation objectives. As you select objectives, on the left pane, the Code Generation Advisor
updates the list of checks it runs on your model. If your model is configured with an ERT-based
target, more objectives are available. For this example, the model is configured with an ERT-
based target. If your objectives are execution efficiency and traceability, in that priority, do the
following:

a In Available objectives, double-click Execution efficiency. Execution efficiency
is added to Selected objectives - prioritized.

b In Available objectives, double-click Traceability. Traceability is added to Selected
objectives - prioritized under Execution efficiency.
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4 To run the checks listed in the left pane of the Code Generation Advisor, click Run Selected
Checks.

5 In the Code Generation Advisor window, review the results for Check model configuration
settings against code generation objectives by selecting it from the left pane. The results for
that check are displayed in the right pane.

Check model configuration settings against code generation objectives triggers a warning
for these issues:

• Parameters are set to values other than the value recommended for the specified code
generation objectives.

• Selected code generation objectives differ from the objectives set in the model.

Click Modify Parameters to set:

• Parameters to the value recommended for the specified code generation objectives.
• Code generation objectives in the model to the objectives specified in the Code Generation

Advisor.

6 In the Code Generation Advisor window, review the results for the remaining checks by selecting
them from the left pane. The results for the checks display in the right pane.
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7 After reviewing the check results, you can choose to fix warnings and failures, as described in
“Fix a Model Advisor Check Warning or Failure”.

When you specify an efficiency or Safety precaution objective, the Code Generation Advisor includes
additional checks. When you make changes to one of these additional checks, previous check results
can potentially become invalid and need to be rerun.

Configure Model for Code Generation Objectives by Using
Configuration Parameters Dialog Box
This example shows how to configure and check your model to meet code generation objectives via
the Configuration Parameters dialog box:

1 Open the Configuration Parameters dialog box. Select Code Generation.
2 Specify a system target file. If you specify an ERT-based target, more objectives are available. For

this example, choose an ERT-based target such as ert.tlc.
3 Click Set Objectives.
4 In the “Set Objectives — Code Generation Advisor Dialog Box”, specify your objectives. For

example, if your objectives are execution efficiency and traceability, in that priority, do the
following:

a In Available objectives, double-click Execution efficiency. Execution efficiency
is added to Selected objectives - prioritized.

b In Available objectives, double-click Traceability. Traceability is added to Selected
objectives - prioritized under Execution efficiency.

c To accept the objectives, click OK. In the Configuration Parameters dialog box, Code
Generation > Prioritized objectives is updated.

5 On the Code Generation pane, click Check Model.
6 In the System Selector window, select the model or subsystem that you want to review, and then

click OK. The Code Generation Advisor opens and reviews the model or subsystem that you
specified.

7 In the Code Generation Advisor window, review the results by selecting a check from the left
pane. The results for that check display in the right pane.
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8 After reviewing the check results, you can choose to fix warnings and failures, as described in
“Fix a Model Advisor Check Warning or Failure”.

When you specify an efficiency or Safety precaution objective, the Code Generation Advisor includes
additional checks. When you make changes to one of these additional checks, previous check results
can potentially become invalid and need to be rerun.

For more information, see “Set Objectives — Code Generation Advisor Dialog Box”

See Also

Related Examples
• “Configure Code Generation Objectives Programmatically” on page 47-7
• “Recommended Settings Summary for Model Configuration Parameters”
• “Recommended Model Configuration Parameters for Polyspace Analysis” (Polyspace Bug Finder)
• “Code Generation Advisor Checks”
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Configure Code Generation Objectives Programmatically
This example shows how to configure code generation objectives by writing a MATLAB script or
entering commands at the command line.

1 Specify a system target file. If you specify an ERT-based target, more objectives are available. For
this example, specify ert.tlc. model_name is the name or handle to the model.

set_param(model_name, 'SystemTargetFile', 'ert.tlc');
2 Specify your objectives. For example, if your objectives are execution efficiency and traceability,

in that priority, enter:

set_param(model_name, 'ObjectivePriorities',...
{'Execution efficiency', 'Traceability'});

3 Execute the Code Generation Advisor, by using either the Code Generation Advisor or in the
Configuration Parameters dialog box. For more information, see “Configure Model for Code
Generation Objectives by Using Code Generation Advisor” on page 47-2.

When you specify a GRT-based system target file, you can specify an objective at the command line. If
you specify ROM efficiency, RAM efficiency, Traceability, MISRA C:2012 guidelines,
Polyspace, or Safety precaution, the build process changes the objective to Unspecified
because you have specified a value that is invalid when using a GRT-based target.

See Also

Related Examples
• “Configure Model for Code Generation Objectives by Using Code Generation Advisor” on page

47-2
• “Create Custom Code Generation Objectives” on page 47-13
• “Recommended Settings Summary for Model Configuration Parameters”
• “Code Generation Advisor Checks”
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Check Model and Configuration for Code Generation
You can use the Model Advisor checks to assess model readiness to generate code. To check and
configure your model for code generation application objectives such as traceability or debugging,
use the Code Generation Advisor.

For information about See
Model Advisor “Run Model Advisor Checks”
Code Generation Advisor “Configure Model for Code Generation Objectives

by Using Code Generation Advisor” on page 47-2
Checks available with Simulink Coder “Simulink Coder Checks”
Checks available with Embedded Coder “Embedded Coder Checks”

To check model rtwdemo_throttlecntrl for code efficiency, use the Model Advisor.

1 Open rtwdemo_throttlecntrl. Save a copy as throttlecntrl in a writable location on your
MATLAB path.

2 On the Modeling tab, click Model Advisor. A dialog box opens showing the model system
hierarchy.

3 Click throttlecntrl and then click OK. The Model Advisor window opens.
4 Expand By Task > Code Generation Efficiency. To check your model for code generation

efficiency, use the checks in the folder. By default, checks that do not trigger an Update Diagram
are selected. The checks available for code generation efficiency depend on whether you have a
Simulink Coder or Embedded Coder license.

5 In the left pane, select the remaining checks, and then select Code Generation Efficiency.
6 In the right pane, select Show report after run and click Run Selected Checks. The report

shows a Run Summary that flags check warnings.
7 Review the report. The warnings highlight issues that impact code efficiency. For more

information about the report, see “View Model Advisor Check Reports”.

Check Model During Code Generation
To review a model as part of the code generation process, use the Code Generation Advisor .

1 To select and prioritize your code generation objectives, on the Configuration Parameters >
Code Generation pane, click Set Objectives.

2 On the Configuration Parameters > Code Generation > General pane, select one of the
following from Check model before generating code:

• On (proceed with warnings)
• On (stop for warnings)

3 If you want to only generate code, select Generate code only. Otherwise clear the check box to
build an executable.

4 Apply your changes. Press Ctrl+B to generate code or build the model.

If the Code Generation Advisor issues failures or warnings, and you specified:
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• On (proceed with warnings) — The Code Generation Advisor window opens while the
build process proceeds. After the build process is complete, you can review the results.

• On (stop for warnings) — The build process halts and displays the Diagnostic Viewer. To
continue, you must review and resolve the Code Generation Advisor results or clear the
Check model before generating code parameter.

5 In the Code Generation Advisor window, review the results by selecting a check from the left
pane. The results for that check display in the right pane.

6 After reviewing the check results, you can choose to fix warnings and failures as described in
“Fix a Model Advisor Check Warning or Failure”.

Note When you specify an efficiency or Safety precaution objective, the Code Generation
Advisor includes additional checks. When you make changes to one of these additional checks,
previous check results can potentially become invalid and need to be rerun.

For more information, see “Set Objectives — Code Generation Advisor Dialog Box”
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Embedded Coder Model Advisor Checks for Standards,
Guidelines, and Code Efficiency

To check that your model meets guidelines, standards, and is ready to generate code, you can use the
Model Advisor checks available with Embedded Coder.

• On the Modeling tab, select Model Advisor.
• In the Model Advisor window, expand the By Task folder. The folder contains Model Advisor

checks that you can run to help accomplish the task.

For more information about the Model Advisor, see “Run Model Advisor Checks”.

The table summarizes the Embedded Coder Model Advisor checks that are available in the By Task
folders.

By Task folder Model Advisor checks
Modeling Standards
for MAB

Check for blocks not recommended for C/C++ production code deployment

Code Generation
Efficiency

Identify lookup table blocks that generate expensive out-of-range checking
code

Check output types of logic blocks

Identify questionable software environment specifications

Identify questionable code instrumentation (data I/O)

Identify blocks that generate expensive fixed-point and saturation code

Identify blocks that generate expensive rounding code

Identify questionable fixed-point operations

Check configuration parameters for generation of inefficient saturation code
Modeling Standards
for

• IEC 61508, IEC
62304, ISO
26262, and EN
50128

Check for blocks not recommended for C/C++ production code deployment

Modeling Standards
for DO-178C/DO-331

Check for blocks not recommended for C/C++ production code deployment

Check the hardware implementation

Identify questionable subsystem settings
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By Task folder Model Advisor checks
Modeling Guidelines
for MISRA C:2012

Check configuration parameters for MISRA C:2012

Check for blocks not recommended for C/C++ production code deployment

Check for blocks not recommended for MISRA C:2012

Check for unsupported block names

Check usage of Assignment blocks

Check for switch case expressions without a default case

Check for missing error ports for AUTOSAR receiver interfaces

Check for bitwise operations on signed integers

Check for recursive function calls

Check for equality and inequality operations on floating-point values

Check for missing const qualifiers in model functions

Check bus object names that are used as element names
Modeling Guidelines
for secure coding
standards (CERT C,
CWE, ISO/IEC TS
17961)

Check configuration parameters for secure coding standards

Check for blocks not recommended for C/C++ production code deployment

Check for blocks not recommended for secure coding standards

Check usage of Assignment blocks

Check for switch case expressions without a default case

Check for bitwise operations on signed integers

Check for equality and inequality operations on floating-point values

Check integer word length

If you have a Simulink Design Verifier™ license, the following checks are
also available.

Detect Dead Logic

Detect Integer Overflow

Detect Division by Zero

Detect Out Of Bound Array Access

Detect Violation of Specified Minimum and Maximum Values
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See Also

Related Examples
• “Check Your Model Using the Model Advisor”
• “Simulink Coder Model Advisor Checks for Standards and Code Efficiency”
• “Modeling Guidelines for Model Configuration” on page 2-31
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Create Custom Code Generation Objectives
In this section...
“Specify Parameters in Custom Objectives” on page 47-13
“Specify Checks in Custom Objectives” on page 47-13
“Determine Checks and Parameters in Existing Objectives” on page 47-14
“Steps to Create Custom Objectives” on page 47-15

The Code Generation Advisor reviews your model based on objectives that you specify. If the
predefined efficiency, traceability, Safety precaution, and debugging objectives do not meet your
requirements, you can create custom objectives.

To create custom objectives:

• Create an objective and add parameters and checks to this new objective.
• Create an objective based on an existing objective, then add, modify, and remove the parameters

and checks within that new objective.

Specify Parameters in Custom Objectives
When you create a custom objective, you specify the values of configuration parameters that the Code
Generation Advisor reviews. You can use the following methods:

• addParam — Add parameters and specify the values that the Code Generation Advisor reviews in
Check model configuration settings against code generation objectives.

• modifyInheritedParam — Modify inherited parameter values that the Code Generation Advisor
reviews in Check model configuration settings against code generation objectives.

• removeInheritedParam — Remove inherited parameters from a new objective that is based on
an existing objective. When you select multiple objectives, if another selected objective includes
this parameter, the Code Generation Advisor reviews the parameter value in Check model
configuration settings against code generation objectives.

Specify Checks in Custom Objectives
Objectives include the Check model configuration settings against code generation objectives
check by default. When you create a custom objective, you specify the list of additional checks that
are associated with the custom objective. You can use the following methods:

• addCheck — Add checks to the Code Generation Advisor. When you select the custom objective,
the Code Generation Advisor displays the check, unless you specify an additional objective with a
higher priority that excludes the check.

For example, add a check to the Code Generation Advisor to include a custom check in the
automatic model checking process.

• excludeCheck — Exclude checks from the Code Generation Advisor. When you select multiple
objectives, if you specify an additional objective that includes this check as a higher priority
objective, the Code Generation Advisor displays this check.

For example, exclude a check from the Code Generation Advisor when a check takes a long time
to process.
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• removeInheritedCheck — Remove inherited checks from a new objective that is based on an
existing objective. When you select multiple objectives, if another selected objective includes this
check, the Code Generation Advisor displays the check.

For example, remove an inherited check, rather than exclude the check, when the check takes a
long time to process, but the check is important for another objective.

Determine Checks and Parameters in Existing Objectives
When you base a new objective on an existing objective, you can determine what checks and
parameters the existing objective contains. The Code Generation Advisor contains the list of checks in
each objective.

For example, the Efficiency objective includes checks that you can see in the Code Generation
Advisor.

1 Open the rtwdemo_rtwecintro model.
2 Specify an ERT-based target.
3 On C Code tab, click C/C++ Code Advisor.
4 In the System Selector window, select the model or subsystem that you want to review, and then

click OK.
5 In the Code Generation Advisor, on the Code Generation Objectives pane, select the code

generation objectives. As you select objectives, on the left pane, the Code Generation Advisor
updates the list of checks it runs on your model. For this example, select Execution
efficiency. In Available objectives, double-click Execution efficiency. Execution
efficiency is added to Selected objectives - prioritized.

In the left pane, the Code Generation Advisor lists the checks for the Execution efficiency
objective. The first check, Check model configuration settings against code generation
objectives, lists parameters and values specified by the objective. For example, the Code Generation
Advisor displays the list of parameters and the recommended values in the Execution efficiency
objective. To see the list of parameters and values:

1 Run Check model configuration settings against code generation objectives.
2 Click Modify Parameters.
3 Rerun the check.

In the check results, the Code Generation Advisor displays the list of parameters and recommended
values for the Execution efficiency objective.
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Steps to Create Custom Objectives
To create a custom objective:

1 Create an sl_customization.m file.

• Specify custom objectives in a single sl_customization.m file only or the software
generates an error. This issue is true even if you have more than one sl_customization.m
file on your MATLAB path.

• Except for the matlabroot/work folder, do not place an sl_customization.m file in your
root MATLAB folder or its subfolders. Otherwise, the software ignores the customizations that
the file specifies.

2 Create an sl_customization function that takes a single argument. When the software
invokes the function, the value of this argument is the Simulink customization manager. In the
function:

• To create a handle to the code generation objective, use the ObjectiveCustomizer
constructor.

• To register a callback function for the custom objectives, use the
ObjectiveCustomizer.addCallbackObjFcn method.

• To add a call to execute the callback function, use the
ObjectiveCustomizer.callbackFcn method.

For example:
function sl_customization(cm)
%SL_CUSTOMIZATION objective customization callback

objCustomizer = cm.ObjectiveCustomizer;
index = objCustomizer.addCallbackObjFcn(@addObjectives);
objCustomizer.callbackFcn{index}();

end

3 Create a MATLAB callback function that:

• Creates code generation objective objects by using the
rtw.codegenObjectives.Objective constructor.

• Adds, modifies, and removes configuration parameters for each objective by using the
addParam, modifyInheritedParam, and removeInheritedParam methods.

• Includes and excludes checks for each objective by using the addCheck, excludeCheck, and
removeInheritedCheck methods.

• Registers objectives by using the register method.

The following example shows how to create an objective Reduce RAM Example. Reduce RAM
Example includes five parameters and three checks that the Code Generation Advisor reviews.
function addObjectives

% Create the custom objective
obj = rtw.codegenObjectives.Objective('ex_ram_1');
setObjectiveName(obj, 'Reduce RAM Example');

% Add parameters to the objective
addParam(obj, 'DefaultParameterBehavior', 'Inlined');
addParam(obj, 'BooleanDataType', 'on');
addParam(obj, 'OptimizeBlockIOStorage', 'on');
addParam(obj, 'EnhancedBackFolding', 'on');
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addParam(obj, 'BooleansAsBitfields', 'on');

% Add additional checks to the objective
% The Code Generation Advisor automatically includes 'Check model
% configuration settings against code generation objectives' in every
% objective.
addCheck(obj, 'mathworks.design.UnconnectedLinesPorts');
addCheck(obj, 'mathworks.design.Update');

%Register the objective
register(obj);

end

The following example shows you how to create an objective My Traceability Example based
on the existing Traceability objective. The custom objective modifies, removes, and adds
parameters that the Code Generation Advisor reviews. It also adds and removes checks from the
Code Generation Advisor.
function addObjectives

% Create the custom objective from an existing objective
obj = rtw.codegenObjectives.Objective('ex_my_trace_1', 'Traceability');
setObjectiveName(obj, 'My Traceability Example');

% Modify parameters in the objective
modifyInheritedParam(obj, 'GenerateTraceReportSf', 'Off');
removeInheritedParam(obj, 'ConditionallyExecuteInputs');
addParam(obj, 'MatFileLogging', 'On');

% Modify checks in the objective
addCheck(obj, 'mathworks.codegen.SWEnvironmentSpec');
removeInheritedCheck(obj, 'mathworks.codegen.CodeInstrumentation');

%Register the objective
register(obj);

end

4 If you previously opened the Code Generation Advisor, close the model from which you opened
the Code Generation Advisor.

5 Refresh the customization manager. At the MATLAB command line, enter
sl_refresh_customizations.

6 Open your model and review the new objectives.

See Also

Related Examples
• “Configure Model for Code Generation Objectives by Using Code Generation Advisor” on page

47-2
• “Configure Code Generation Objectives Programmatically” on page 47-7
• “Recommended Settings Summary for Model Configuration Parameters”
• “Code Generation Advisor Checks”
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Configuration Variations
Every model contains one or more named configuration sets that specify model parameters such as
solver options, code generation options, and other choices. A model can contain multiple
configuration sets, but only one configuration set is active at a time. For more information on
configuration sets and how to view and edit them in the Configuration Parameters dialog box, see
“Manage Configuration Sets for a Model”.

A configuration set includes parameters that specify code generation in general. For more
information, see “Configure Model and Generate Code” on page 50-11. With Embedded Coder and
an ERT system target file, more parameters are available for fine-tuning to optimize and customize
the appearance of the generated code.

Multiple configuration sets can be useful in embedded systems development. By defining multiple
configuration sets in a model, you can easily retarget code generation from that model. For example,
one configuration set can specify the default ERT target with external mode support enabled for rapid
prototyping. Another configuration set can specify the ERT-based target for Visual C++ to generate
production code for deployment of the application. Activation of either configuration set fully
reconfigures the model for that type of code generation.

See Also

Related Examples
• “Manage Configuration Sets for a Model”
• “Configure Model and Generate Code” on page 50-11
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Configure and Optimize Model with Configuration Wizard
Blocks

The Embedded Coder software provides a library of Configuration Wizard blocks and scripts to help
you configure and optimize code generation from your models.

In this section...
“Configuration Wizard Block Library” on page 47-18
“Add a Configuration Wizard Block” on page 47-19
“Use Configuration Wizard Blocks to Configure Your Model” on page 47-20
“Create a Custom Configuration Wizard Block” on page 47-20

Configuration Wizard Block Library
The library provides a Configuration Wizard block that you can customize. It also provides four preset
Configuration Wizard blocks that update the active configuration parameters for a specified goal.

Block Description
Custom MATLAB file Update active configuration parameters of parent

model by using a custom file
ERT (optimized for fixed-point) Update active configuration parameters of parent

model for ERT fixed-point code generation
ERT (optimized for floating-point) Update active configuration parameters of parent

model for ERT floating-point code generation
GRT (debug for fixed/floating-point) Update active configuration parameters of parent

model for GRT fixed- or floating-point code
generation with debugging enabled

GRT (optimized for fixed/floating-point) Update active configuration parameters of parent
model for GRT fixed- or floating-point code
generation
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When you add one of the preset Configuration Wizard blocks to your model and double-click it, a
predefined MATLAB file script configures parameters of the active configuration set without manual
intervention. The preset blocks optimally configure the parameters for one of the following cases:

• Fixed-point code generation with the ERT target
• Floating-point code generation with the ERT target
• Fixed-point or floating-point code generation with TLC debugging parameters enabled, with the

GRT target.
• Fixed-point or floating-point code generation with the GRT target

The Custom block provides an example MATLAB file script that you can adapt to your requirements.

You can also set up the Configuration Wizard blocks to invoke the build process after configuring the
model.

Add a Configuration Wizard Block
The Configuration Wizard blocks are available in the Embedded Coder block library. To use a
Configuration Wizard block:

1 Open the model that you want to configure.
2 Open the Embedded Coder block library by typing the command rtweclib.
3 Double-click the Configuration Wizards icon. The Configuration Wizards sublibrary opens.
4 Select the Configuration Wizard block that you want to use and drag it into your model. This

model contains the ERT (optimized for fixed-point) Configuration Wizard block.

5 If you want the Configuration Wizard block to invoke the build process after configuration, right-
click the Configuration Wizard block in your model, and select Mask > Mask Parameters from
the context menu. Then, select the Invoke build process after configuration parameter. Do
not change the Configure the model for block parameter, unless you want to create a custom
block and script. In that case, see “Create a Custom Configuration Wizard Block” on page 47-
20.

6 Click Apply and close the Mask Parameters dialog box.
7 Save the model.
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Use Configuration Wizard Blocks to Configure Your Model
After you add a Configuration Wizard block to your model, to configure your model, double-click the
block. The script associated with the block sets parameters of the active configuration set that are
relevant to code generation (including selection of the target). You can see that the parameters have
changed by opening the Configuration Parameters dialog box and examining the parameter settings.

If you selected the Invoke build process after configuration block parameter, the script also
initiates the code generation and build process.

Note To provide a quick way to switch between configurations, you can add more than one
Configuration Wizard block to your model.

Create a Custom Configuration Wizard Block
The Custom Configuration Wizard block and the associated MATLAB file script, matlabroot/
toolbox/coder/simulinkcoder_core/rtwsampleconfig.m, provide a starting point for
customization.

Set Up a Configuration Wizard Block

Set up a custom Configuration Wizard block and link it to a script. If you want to use the block in
more than one mode, it is advisable to create a Simulink library to contain the block.

To begin, make a copy of the example script for later customization:

1 To store your custom script, create a folder. This folder must not be anywhere inside the MATLAB
folder structure (that is, it must not be under matlabroot).

The example refers to this folder as /my_wizards.
2 Add the folder to the MATLAB path. Save the path for future sessions.
3 Copy the example script rtwsampleconfig.m in the folder matlabroot/toolbox/rtw/rtw

(open) to the /my_wizards folder that you created. Then, rename the script. This example uses
the name my_configscript.m.

4 Open the example script into the MATLAB editor. Scroll to the end of the file and enter the
following line of code:

disp('Custom Configuration Wizard Script completed.');

This statement is used later as a test to see that your custom block has executed the script.
5 Save your script and close the MATLAB editor.

The next task is to create a Simulink library and add a custom block to it.

1 Open the Embedded Coder block library and the Configuration Wizards sublibrary, as described
in “Add a Configuration Wizard Block” on page 47-19.

2 On the Library tab, select New > Library. From the Simulink Start Page, choose a Blank
Library. An empty library window opens.

3 Select the Custom MATLAB file block from the Configuration Wizards sublibrary and drag it into
the empty library window.
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4 To distinguish your custom block from the original, edit the Custom MATLAB file label under the
block.

5 On the Library tab, select Save > Save as. Save the library to the /my_wizards folder, under
your library name of choice. In this figure, the library is saved as ex_custom_button and the
block is labeled my_wizard MATLAB-file.

The next task is to link the custom block to the custom script:

1 Right-click the block in your model and select Mask > Mask Parameters from the context
menu. The Configure the model for menu is set to Custom. When Custom is selected, the
Configuration function edit field is enabled so that you can enter the name of a custom script.

2 In the Configuration function field, enter the name of your custom script . (Do not enter the .m
file name extension, which is implicit.)

3 By default, the Invoke build process after configuration parameter is cleared. You can change
the default for your custom block by selecting this option. For now, leave this parameter cleared.

4 Click Apply and close the Mask Parameters dialog box.
5 Save the library.
6 Close the Embedded Coder block library and the Configuration Wizards sublibrary. Leave your

custom library open for use in the next task.

Test your block and script in a model.

1 Open the vdp model by typing the command:

vdp
2 Open the Configuration Parameters dialog box and view the parameters by clicking Code

Generation in the list in the left pane of the dialog box.
3 Observe that vdp is configured, by default, for the GRT target. Close the Configuration

Parameters dialog box.
4 Select your custom block from your custom library. Drag the block into the vdp model.
5 In the vdp model, double-click your custom block.
6 In the MATLAB window, you see the test message that you previously added to your script:

Custom Configuration Wizard Script completed.
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The test message indicates that the custom block executed the script.
7 Reopen the Configuration Parameters dialog box and view the Code Generation pane again. The

model is now configured for the ERT target.

Before applying further edits to your custom script, proceed to the next section to learn about the
operation and conventions of Configuration Wizard scripts.

Create a Configuration Wizard Script

Create your custom Configuration Wizard script by copying and modifying the example script,
rtwsampleconfig.m.
The Configuration Function

The example script implements a single function without a return value. The function takes a single
argument cs:

function rtwsampleconfig(cs)

The argument cs is a handle to a proprietary object that contains information about the active
configuration set. The Simulink software obtains this handle and passes it in to the configuration
function when you double-click a Configuration Wizard block.

Your custom script must conform to this prototype. Your code must use cs as a “black-box” object
that transmits information to and from the active configuration set.
Access Configuration Set Parameters

To set parameters or obtain parameter values, use the Simulink set_param and get_param
functions.

Option names are passed in to set_param and get_param as character vectors specifying an
internal option name. The internal option name can be different from the option label on the UI (for
example, the Configuration Parameters dialog box). The example configuration accompanies each
set_param and get_param call with a comment that correlates internal option names to UI option
labels. For example:

set_param(cs,'LifeSpan','1'); % Application lifespan (days)

To obtain the current setting of an option in the active configuration set, call get_param. Pass in the
cs object as the first argument, followed by the internal option name. For example, the following
code excerpt tests the setting of the Create code generation report option:

if strcmp(get_param(cs, 'GenerateReport'), 'on')
    ...

To set an option in the active configuration set, call set_param. Pass in the cs object as the first
argument, followed by one or more parameter/value pairs that specify the internal option name and
its value. For example, the following code excerpt turns off the Support absolute time option:

set_param(cs,'SupportAbsoluteTime','off');

Select a Target

A Configuration Wizard script must select a target configuration. The example script uses the ERT
target as a default. The script first stores character vector variables that correspond to the required
System target file, Template makefile, and Make command settings:
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stf = 'ert.tlc';
tmf = 'ert_default_tmf';
mc  = 'make_rtw';

You select the system target file by passing the cs object and the stf character vector to the
switchTarget function:

switchTarget(cs,stf,[]);

Set the template makefile and make command options by using set_param calls:

set_param(cs,'TemplateMakefile',tmf);
set_param(cs,'MakeCommand',mc);

To select a target, your custom script must set up the character vector variables stf, tmf, and mc
and pass them to the calls.

Obtain Target and Configuration Set Information

The following utility functions and properties are provided so that your code can obtain information
about the current target and configuration set with the cs object:

• isValidParam(cs, 'option'): The option argument is an internal option name.
isValidParam returns true if option can be accessed by using the get_param function in the
context of the active configuration set.

• getPropEnabled(cs, 'option'): The option argument is an internal option name. Returns
true if this option is enabled (that is, writable).

• IsERTTarget property: Your code can detect whether the currently selected target is derived
from the ERT target by checking the IsERTTarget property, as follows:

  isERT = strcmp(get_param(cs,'IsERTTarget'),'on');

You can use this information to determine whether the script must configure ERT-specific parameters,
for example:

if isERT
  set_param(cs,'ZeroExternalMemoryAtStartup','off');
  set_param(cs,'ZeroInternalMemoryAtStartup','off');
  set_param(cs,'InitFltsAndDblsToZero','off');
  set_param(cs,'NoFixptDivByZeroProtection','on')
end

Invoke a Configuration Wizard Script from the Command Line

Configuration Wizard scripts can be run from the MATLAB command line.

Before invoking the script, you must open a model and instantiate a cs object to pass in as an
argument to the script. After running the script, you can invoke the build process with the slbuild
command. The following example opens, configures, and builds a model.

open my_model;
cs = getActiveConfigSet ('my_model');
rtwsampleconfig(cs);
slbuild('my_model');
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See Also

Related Examples
• “Generate Code by Using the Quick Start Tool” on page 51-9
• “Generate Code and Simulate Models in a Project” on page 50-99
• “Generate Code and Simulate Models Programmatically with Project” on page 50-102
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Aircraft Position Radar Model
This model shows the code generated for a Simulink model containing a MATLAB script.

The model contains an Extended Kalman Filter that estimates aircraft position from radar
measurements. The MATLAB script rtwdemo_eml_aero_radar.m contains data for running the model.
The estimated and actual positions are saved to the workspace and are plotted at the end of the
simulation by the program rtwdemo_aero_radplot (called from the simulation automatically).

Review and Simulate the Model

In this section you should review the model and perform a simulation.

Open the Simulink model.

model='rtwdemo_eml_aero_radar';
open_system(model)
rtwdemo_eml_aero_radar([],[],[],'compile');
rtwdemo_eml_aero_radar([],[],[],'term');

Open the MATLAB Function block RadarTracker in the MATLAB Editor.

open_system([model,'/RadarTracker'])
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Simulate the model and review the results (displayed automatically).

sim(model)

Generate Code for the Model

In this section you will generate code for the Kalman Filter portion of the model using the subsystem
build functionality provided by Simulink Coder. In the first build, the model is configured to generate
code using Simulink Coder. In the second build, the model is configured to generate code using
Embedded Coder.

% Create a temporary folder (in your system's temporary folder) for the
% build and inspection process.
currentDir = pwd;
[~,cgDir] = rtwdemodir();

Configure and build the model using Simulink Coder.

rtwconfiguredemo(model,'GRT')
slbuild([model,'/RadarTracker'])

### Starting build procedure for: RadarTracker
### Successful completion of build procedure for: RadarTracker
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Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                                    
=============================================================================================
RadarTracker  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 33.717s

Configure and build the model using Embedded Coder.

rtwconfiguredemo(model,'ERT')
slbuild([model,'/RadarTracker'])

### Starting build procedure for: RadarTracker
### Successful completion of build procedure for: RadarTracker

Build Summary

Top model targets built:

Model         Action                       Rebuild Reason                                    
=============================================================================================
RadarTracker  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 46.164s

A portion of RadarTracker.c is listed below.

cfile = fullfile(cgDir,'RadarTracker_ert_rtw','RadarTracker.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void RadarTracker_step(void)
{
  real_T P_d_tmp[16];
  real_T Phi_0[16];
  real_T Q[16];
  real_T Q_0[16];
  real_T M[8];
  real_T W[8];
  real_T tmp[8];
  real_T x_tmp[8];
  real_T Phi_1[4];
  real_T Bearinghat;
  real_T M_tmp;
  real_T M_tmp_0;
  real_T Rangehat;
  real_T r;
  real_T tmp_0;
  int32_T Phi_tmp;
  int32_T Phi_tmp_tmp;
  int32_T i;
  int32_T j;
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  int8_T Phi[16];
  static const real_T e[4] = { 0.0, 0.005, 0.0, 0.005 };

  static const real_T R[4] = { 90000.0, 0.0, 0.0, 1.0E-6 };

  /* MATLAB Function: '<Root>/RadarTracker' incorporates:
   *  Inport: '<Root>/meas'
   */
  Phi[0] = 1;
  Phi[4] = 1;
  Phi[8] = 0;
  Phi[12] = 0;
  Phi[2] = 0;
  Phi[6] = 0;
  Phi[10] = 1;
  Phi[14] = 1;
  Phi[1] = 0;
  Phi[3] = 0;
  Phi[5] = 1;
  Phi[7] = 0;
  Phi[9] = 0;
  Phi[11] = 0;
  Phi[13] = 0;
  Phi[15] = 1;
  memset(&Q[0], 0, sizeof(real_T) << 4U);
  for (j = 0; j < 4; j++) {
    Q[j + (j << 2)] = e[j];
    for (i = 0; i < 4; i++) {
      Phi_tmp_tmp = i << 2;
      Phi_tmp = j + Phi_tmp_tmp;
      Phi_0[Phi_tmp] = 0.0;
      Phi_0[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp] * (real_T)Phi[j];
      Phi_0[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp + 1] * (real_T)Phi[j + 4];
      Phi_0[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp + 2] * (real_T)Phi[j + 8];
      Phi_0[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp + 3] * (real_T)Phi[j + 12];
    }
  }

  for (i = 0; i < 4; i++) {
    Phi_1[i] = 0.0;
    for (j = 0; j < 4; j++) {
      Phi_tmp_tmp = (j << 2) + i;
      rtDW.P_d[Phi_tmp_tmp] = (((Phi_0[i + 4] * (real_T)Phi[j + 4] + Phi_0[i] *
        (real_T)Phi[j]) + Phi_0[i + 8] * (real_T)Phi[j + 8]) + Phi_0[i + 12] *
        (real_T)Phi[j + 12]) + Q[Phi_tmp_tmp];
      Phi_1[i] += (real_T)Phi[Phi_tmp_tmp] * rtDW.xhat[j];
    }
  }

  rtDW.xhat[0] = Phi_1[0];
  rtDW.xhat[1] = Phi_1[1];
  rtDW.xhat[2] = Phi_1[2];
  rtDW.xhat[3] = Phi_1[3];
  Rangehat = sqrt(rtDW.xhat[0] * rtDW.xhat[0] + rtDW.xhat[2] * rtDW.xhat[2]);
  Bearinghat = atan2(rtDW.xhat[2], rtDW.xhat[0]);
  M_tmp = sin(Bearinghat);
  M_tmp_0 = cos(Bearinghat);
  M[0] = M_tmp_0;
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  M[2] = 0.0;
  M[4] = M_tmp;
  M[6] = 0.0;
  M[1] = -M_tmp / Rangehat;
  M[3] = 0.0;
  M[5] = M_tmp_0 / Rangehat;
  M[7] = 0.0;
  rtY.residual[0] = rtU.meas[0] - Rangehat;
  rtY.residual[1] = rtU.meas[1] - Bearinghat;
  for (i = 0; i < 2; i++) {
    for (j = 0; j < 4; j++) {
      Phi_tmp_tmp = (j << 1) + i;
      x_tmp[j + (i << 2)] = M[Phi_tmp_tmp];
      W[Phi_tmp_tmp] = 0.0;
      Phi_tmp = j << 2;
      W[Phi_tmp_tmp] += rtDW.P_d[Phi_tmp] * M[i];
      W[Phi_tmp_tmp] += rtDW.P_d[Phi_tmp + 2] * M[i + 4];
    }
  }

  for (i = 0; i < 2; i++) {
    for (j = 0; j < 2; j++) {
      Phi_tmp_tmp = j << 2;
      Phi_tmp = (j << 1) + i;
      Phi_1[Phi_tmp] = (((x_tmp[Phi_tmp_tmp + 1] * W[i + 2] + x_tmp[Phi_tmp_tmp]
                          * W[i]) + x_tmp[Phi_tmp_tmp + 2] * W[i + 4]) +
                        x_tmp[Phi_tmp_tmp + 3] * W[i + 6]) + R[Phi_tmp];
    }
  }

  if (fabs(Phi_1[1]) > fabs(Phi_1[0])) {
    r = Phi_1[0] / Phi_1[1];
    Rangehat = 1.0 / (r * Phi_1[3] - Phi_1[2]);
    Bearinghat = Phi_1[3] / Phi_1[1] * Rangehat;
    M_tmp = -Rangehat;
    M_tmp_0 = -Phi_1[2] / Phi_1[1] * Rangehat;
    Rangehat *= r;
  } else {
    r = Phi_1[1] / Phi_1[0];
    Rangehat = 1.0 / (Phi_1[3] - r * Phi_1[2]);
    Bearinghat = Phi_1[3] / Phi_1[0] * Rangehat;
    M_tmp = -r * Rangehat;
    M_tmp_0 = -Phi_1[2] / Phi_1[0] * Rangehat;
  }

  for (i = 0; i < 4; i++) {
    for (j = 0; j < 2; j++) {
      Phi_tmp_tmp = j << 2;
      Phi_tmp = i + Phi_tmp_tmp;
      tmp[Phi_tmp] = 0.0;
      tmp[Phi_tmp] += x_tmp[Phi_tmp_tmp] * rtDW.P_d[i];
      tmp[Phi_tmp] += x_tmp[Phi_tmp_tmp + 1] * rtDW.P_d[i + 4];
      tmp[Phi_tmp] += x_tmp[Phi_tmp_tmp + 2] * rtDW.P_d[i + 8];
      tmp[Phi_tmp] += x_tmp[Phi_tmp_tmp + 3] * rtDW.P_d[i + 12];
    }

    W[i] = 0.0;
    W[i] += tmp[i] * Bearinghat;
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    r = tmp[i + 4];
    W[i] += r * M_tmp;
    tmp_0 = W[i] * rtY.residual[0];
    W[i + 4] = 0.0;
    W[i + 4] += tmp[i] * M_tmp_0;
    W[i + 4] += r * Rangehat;
    rtDW.xhat[i] += W[i + 4] * rtY.residual[1] + tmp_0;
  }

  for (i = 0; i < 16; i++) {
    Phi[i] = 0;
  }

  Phi[0] = 1;
  Phi[5] = 1;
  Phi[10] = 1;
  Phi[15] = 1;
  memset(&Q[0], 0, sizeof(real_T) << 4U);
  for (j = 0; j < 4; j++) {
    Q[j + (j << 2)] = 1.0;
    for (i = 0; i < 4; i++) {
      Phi_tmp_tmp = j + (i << 2);
      P_d_tmp[Phi_tmp_tmp] = 0.0;
      Phi_tmp = i << 1;
      P_d_tmp[Phi_tmp_tmp] += M[Phi_tmp] * W[j];
      P_d_tmp[Phi_tmp_tmp] += M[Phi_tmp + 1] * W[j + 4];
    }
  }

  for (i = 0; i < 16; i++) {
    Q_0[i] = Q[i] - P_d_tmp[i];
  }

  for (i = 0; i < 4; i++) {
    for (j = 0; j < 4; j++) {
      Phi_tmp_tmp = j << 2;
      Phi_tmp = i + Phi_tmp_tmp;
      Q[Phi_tmp] = 0.0;
      Q[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp] * Q_0[i];
      Q[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp + 1] * Q_0[i + 4];
      Q[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp + 2] * Q_0[i + 8];
      Q[Phi_tmp] += rtDW.P_d[Phi_tmp_tmp + 3] * Q_0[i + 12];
      Phi_0[j + (i << 2)] = (real_T)Phi[Phi_tmp] - P_d_tmp[Phi_tmp];
    }

    M[i] = 0.0;
    M[i] += W[i] * 90000.0;
    M[i + 4] = 0.0;
    M[i + 4] += W[i + 4] * 1.0E-6;
  }

  for (i = 0; i < 4; i++) {
    for (j = 0; j < 4; j++) {
      Phi_tmp_tmp = j << 2;
      Phi_tmp = i + Phi_tmp_tmp;
      Q_0[Phi_tmp] = 0.0;
      Q_0[Phi_tmp] += Phi_0[Phi_tmp_tmp] * Q[i];
      Q_0[Phi_tmp] += Phi_0[Phi_tmp_tmp + 1] * Q[i + 4];
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      Q_0[Phi_tmp] += Phi_0[Phi_tmp_tmp + 2] * Q[i + 8];
      Q_0[Phi_tmp] += Phi_0[Phi_tmp_tmp + 3] * Q[i + 12];
      P_d_tmp[Phi_tmp] = 0.0;
      P_d_tmp[Phi_tmp] += M[i] * W[j];
      P_d_tmp[Phi_tmp] += M[i + 4] * W[j + 4];
    }
  }

  for (i = 0; i < 16; i++) {
    rtDW.P_d[i] = Q_0[i] + P_d_tmp[i];
  }

  /* Outport: '<Root>/xhatOut' incorporates:
   *  MATLAB Function: '<Root>/RadarTracker'
   */
  rtY.xhatOut[0] = rtDW.xhat[0];
  rtY.xhatOut[1] = rtDW.xhat[1];
  rtY.xhatOut[2] = rtDW.xhat[2];
  rtY.xhatOut[3] = rtDW.xhat[3];
}

You can view the entire generated code in a detailed HTML report, with bi-directional traceability
between model and code.

web(fullfile(cgDir,'RadarTracker_ert_rtw','html','RadarTracker_codegen_rpt.html'))

Close the model and cleanup.

bdclose(model)
rtwdemoclean;
cd(currentDir)
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System Target File Configuration

• “Configure a System Target File” on page 48-2
• “Configure STF-Related Code Generation Parameters” on page 48-5
• “Configure a Code Replacement Library” on page 48-12
• “Configure Standard Math Library for Target System” on page 48-13
• “Compare System Target File Support Across Products” on page 48-16
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Configure a System Target File
To configure a model for code generation, follow the steps in “Select a Solver That Supports Code
Generation” and “Select a System Target File from STF Browser”. When you select a system target
file, other model configuration parameters change to serve requirements of the execution
environment. For example:

• Code interface parameters
• Build process parameters, such as the toolchain or template makefile
• Target hardware parameters, such as word size and byte ordering

After selecting a system target file, you can modify model configuration parameter settings.

You can switch between different system target files in a single workflow for different code
generation purposes (for example, rapid prototyping versus production code deployment). To switch,
set up different configuration sets for the same model and switch the active configuration set for the
current operation. For more information on how to set up configuration sets and change the active
configuration set, see “Manage Configuration Sets for a Model”.

Select a Solver That Supports Code Generation
To build a model, the model configuration must specify a solver that is compatible with code
generation for the system target file. Few system target files support code generation with variable-
step solvers or for models with a nonzero start time.

• For GRT, ERT, and ERT-based system target files, set the Type configuration parameter to Fixed-
step.

• For Rapid Simulation (Rsim) or S-Function (rtwsfcn) system target files, set the Type
configuration parameter to Fixed-step or Variable-step.

For more information about the requirement that you use a fixed-step solver to generate code for a
realtime system target file, see “Time-Based Scheduling and Code Generation” on page 28-2.

The Rapid Simulation (RSim) system target file supports a nonzero start time when the Solver
selection configuration parameter is set to Use Simulink solver module. Other system target
files do not support a nonzero start time –– the code generator does not produce code and the build
process produces an error.

Select a System Target File from STF Browser
After you select a solver (see “Select a Solver That Supports Code Generation”), specify a value for
the System target file configuration parameter. Enter the name of your system target file directly in
the field or use the System Target File Browser to select a file.

To use the System Target File Browser:

1 In the configuration parameters dialog box, next to the System target file field, click the
Browse button. The browser displays a list of available system target files, including
customizations.

2 From the list, select your file, for example, the GRT system target file (grt.tlc). The
background of the list box turns yellow to indicate that the choice is not applied. Click Apply or
OK.
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System Target File Browser

You also can select a system target file programmatically from MATLAB code, as described in “Select
a System Target File Programmatically” on page 48-3.

After selecting a system target file, you can modify model configuration parameter settings. Selecting
a system target file for your model selects either the toolchain approach or template makefile
approach for build process control. For more information about these approaches, see “Choose Build
Approach and Configure Build Process” on page 57-11.

If you want to switch between different system target files in a single workflow for different code
generation purposes, set up different configuration sets for the same model. Switch the active
configuration set for the current operation. This approach is useful for switching between rapid
prototyping and production code deployment. For more information on how to set up configuration
sets and change the active configuration set, see “Manage Configuration Sets for a Model”.

Select a System Target File Programmatically
Simulink models store model-wide parameters and system target file-specific data in configuration
sets. Every configuration set contains a component that defines the structure of a particular system
target file and the current values of relevant options. Simulink loads some of this information from
the system target file that you specify. You can configure models to generate alternative code by
copying and modifying old or adding new configuration sets and browsing to select a new system
target file. Then, you can interactively select an active configuration from among these sets (only one
configuration set can be active at a given time).

Scripts that automate system target file selection must emulate this process.

To program system target file selection:

1 Obtain a handle to the active configuration set with a call to the getActiveConfigSet function.
2 Define character vector variables that correspond to the required system target file, toolchain or

template makefile, and/or make command settings. For example, for the ERT system target file,
you would define variables for the character vectors 'ert.tlc', 'ert_default_tmf', and
'make_rtw'.

3 Select the system target file with a call to the switchTarget function. In the function call,
specify the handle for the active configuration set and the system target file.

4 Set the TemplateMakefile and MakeCommand configuration parameters to the corresponding
variables created in step 2.
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For example:

cs = getActiveConfigSet(model);
stf = 'ert.tlc';
tmf = 'ert_default_tmf';
mc  = 'make_rtw';
switchTarget(cs,stf,[]);
set_param(cs,'TemplateMakefile',tmf);
set_param(cs,'MakeCommand',mc);

For more information about selecting system target files programmatically, see switchTarget.

Develop Custom System Target Files
You can create your own system target files that interface with external code or operating
environments.

For more information on how to make custom system target files appear in the System Target File
Browser and display relevant controls, see “Custom Targets” and the topics it references.

See Also
getActiveConfigSet | switchTarget

More About
• “Configure STF-Related Code Generation Parameters” on page 48-5
• “Configure a Code Replacement Library” on page 48-12
• “Configure Standard Math Library for Target System” on page 48-13
• “Compare System Target File Support Across Products” on page 48-16
• “Custom Targets”

48 System Target File Configuration

48-4



Configure STF-Related Code Generation Parameters
Many model configuration parameters for code generation are specific to GRT, ERT, or ERT-based
system target files.

Specify Generated Code Interfaces
Use interface model configuration parameters to control which libraries to use when generating code,
whether to include support for an API in generated code, and other interface options.

To... Select or Enter...
Specify the standard math
library that the code generator
uses when generating code.

Select C89/C90 (ANSI), C99 (ISO), or C++03 (ISO) for the Standard
math library parameter.

Selecting C89/C90 (ANSI) provides the ANSIa C set of library functions. For
example, selecting C89/C90 (ANSI) results in generated code that calls
sin() whether the input argument is double precision or single precision.
However, if you select C99 (ISO), the generated code calls the function
sinf() when the input argument is single precision. If your compiler
supports the ISO®b C math extensions, selecting the ISO C library can result
in more efficient code.

For more information, see “Standard math library”.

The options for this parameter have dependencies. See Interface
Dependencies.

Specify an application-specific
library that the code generator
uses when generating code.

If you generate application-specific C or C++ code for math functions or
operations, select a value for Code replacement library. Otherwise, specify
None.

For more information about code replacement libraries, see “Choose a Code
Replacement Library” on page 54-6 and “Code replacement library”.

The options for this parameter have dependencies. See Interface
Dependencies.

Direct where the code generator
places fixed-point and other
utility code.

Select Auto or Shared location for Shared code placement. The shared
location directs code for utilities to be placed within the slprj folder in your
working folder, which is used for building referenced models. If you select
Auto,

• When the model contains Model blocks, places utility code within the
slprj/target/_sharedutils folder.

• When the model does not contain Model blocks, places utility code in the
build folder (generally, in model.c or model.cpp).

Specify text to be added to the
variable names used when
logging data to MAT-files and to
distinguish logging data from
code generation and simulation
applications.

Enter a prefix or suffix, such as rt_ or _rt, for the MAT-file variable name
modifier parameter. The code generator prefixes or appends the text to the
variable names for system outputs, states, and simulation time specified in the
Data Import/Export pane. See “Log Program Execution Results” on page 59-
2 for information on MAT-file data logging.
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To... Select or Enter...
Specify data exchange APIs to
be included in generated code.

Select one or more C API options, the ASAP2 interface option, or the
External mode option. When you select External mode, other options
appear. The data exchange APIs are independent, and you can select
combinations of these APIs. For example, you could choose C API and external
mode.

For more information on working with these interfaces, see “Exchange Data
Between Generated and External Code Using C API” on page 60-2, “Export
ASAP2 File for Data Measurement and Calibration” on page 61-2, and
“External Mode Simulations for Parameter Tuning and Signal Monitoring”.

The options for this parameter have dependencies. See Interface
Dependencies.

a. ANSI is a registered trademark of the American National Standards Institute, Inc.
b. ISO is a registered trademark of the International Organization for Standardization.

Note Before setting Standard math library or Code replacement library, verify that your
compiler supports the library you want to use. If you select a parameter value that your toolchain
does not support, compiler errors can occur. For example, if you select standard math library C99
(ISO) and your compiler does not support the ISO C math extensions, compile-time errors could
occur.

When the Embedded Coder product is installed on your system, the Code Generation > Interface
pane expands to include several additional options. For descriptions of Code Generation >
Interface pane parameters, see “Model Configuration Parameters: Code Generation Interface”.

Several interface parameters have dependencies on settings of other parameters. The following table
summarizes the dependencies.
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Interface Dependencies

Parameter Dependencies? Dependency Details
Standard math library Yes Available values depend on Language

selection.
Code replacement library Yes Available values depend on product licensing

and other parameters. For more information,
see “Code replacement library”.

Shared code placement No  
Support: floating-point numbers
(ERT system target files only)

No  

Support: non-finite numbers Yes (ERT)
No (GRT)

For ERT system target files, enabled by
Support floating-point numbers

Support: complex numbers (ERT
system target files only)

No  

Support: absolute time (ERT system
target files only)

No  

Support: continuous time (ERT
system target files only)

Yes Requires that you disable Remove error
status field in real-time model data
structure.

Support: non-inlined S-functions
(ERT system target files only)

Yes Requires that you enable Support floating-
point numbers and Support non-finite
numbers

Classic call interface Yes Requires that you disable Single output/
update function. For ERT system target
files, requires that you enable Support
floating-point numbers.

Single output/update function Yes Disable for Classic call interface
Terminate function required (ERT
system target files only)

Yes  

Code interface packaging Yes Available values depend on Language
selection.

Multi-instance code error diagnostic Yes Set Code interface packaging to Reusable
function or C++ class

Pass root-level I/O as (ERT system
target files only)

Yes Set Code interface packaging to Reusable
function

Use dynamic memory allocation for
model initialization (ERT system
target files only)

Yes Set Code interface packaging to Reusable
function

MAT-file logging Yes For GRT system target files, requires that you
enable Support non-finite numbers; for
ERT system target files, requires that you
enable Support floating-point numbers,
Support non-finite numbers, and
Terminate function required
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Parameter Dependencies? Dependency Details
MAT-file file variable name modifier Yes Enabled by MAT-file logging
Remove error status field in real-
time model data structure (ERT
system target files only)

Yes Requires that you disable Support:
continuous time.

Generate C API for: signals No  
Generate C API for: parameters No  
Generate C API for: states No  
Generate C API for: root-level I/O No  
ASAP2 interface No  
External mode No  
Transport layer Yes Enable External mode
MEX-file arguments Yes Enable External mode
Static memory allocation Yes Enable External mode
Static memory buffer size Yes Enable Static memory allocation

Configure Numeric Data Support
By default, ERT system target files support code generation for integer, floating-point, nonfinite, and
complex numbers.

To Generate Code That
Supports...

Do...

Integer data only Clear Support floating-point numbers. If noninteger data or
expressions are encountered during code generation, an error message
reports the offending blocks and parameters.

Floating-point data Select Support floating-point numbers.
Nonfinite values (for example, NaN,
Inf)

Select Support floating-point numbers and Support non-finite
numbers.

Complex data Select Support complex numbers.

For more information, see “Model Configuration Parameters: Code Generation Interface”.

Configure Time Value Support
Certain blocks require the value of absolute time, elapsed time, or continuous time. Absolute time is
the time from the start of program execution to the present time. Elapsed time is the time elapsed
between two trigger events. Depending on the blocks used, your model could require adjustment of
the configuration settings for supported time values.
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To... Select...
Generate code that creates and
maintains integer counters for
blocks that use absolute or
elapsed time values (default).

Support absolute time. For further information on the allocation and
operation of absolute and elapsed timers, see “Absolute and Elapsed Time
Computation”. If you do not select this parameter and the model includes a
block that uses absolute or elapsed time values, the build process generates
an error.

Generate code for blocks that
rely on continuous time.

Support continuous time. If you do not select this parameter and the
model includes continuous-time blocks, the build process generates an error.

For more information, see “Model Configuration Parameters: Code Generation Interface”.

Configure Noninlined S-Function Support
To generate code for noninlined S-Functions in a model, select Support noninlined S-functions.
The generation of noninlined S-functions requires floating-point and nonfinite numbers. Thus, when
you select Support non-inlined S-functions, the ERT system target file selects Support floating-
point numbers and Support non-finite numbers.

When you select Support non-finite numbers and the model includes a C MEX S-function that does
not have a corresponding TLC implementation (for inlining code generation), the build process
generates an error.

Inlining S-functions is highly advantageous in production code generation, for example in
implementing device drivers. To enforce the use of inlined S-functions for code generation, clear
Support non-inlined S-functions.

When generating code for a model that contains noninlined S-functions with an ERT system target
file, there can be a mismatch between the simulation and code generation results when either of the
following is true:

• Model configuration parameter GenCodeOnly is set to off.
• Model configuration parameter ProdEqTarget is set to off.

To avoid such a mismatch, set ProdEqTarget to on or set GenCodeOnly to on.

Configure Model Function Generation and Argument Passing
For ERT system target files, you can configure model for how functions are generated and how
arguments are passed to the functions.

To... Do...
Generate model function calls that
are compatible with the main
program module of the pre-R2012a
GRT system target file (grt_main.c
or .cpp).

Select Classic call interface and MAT-file logging. In addition,
clearing Remove error status field in real-time model data
structure. Classic call interface provides a quick way to use code
generated in R2012a or higher with a pre-R2012a GRT-based custom
system target file by generating wrapper function calls that interface to
the generated code.
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To... Do...
Reduce overhead and use more local
variables by combining the output
and update functions in a single
model_step function.

Select Single output/update function

Errors or unexpected behavior can occur if a Model block is part of a
cycle and the model configuration enables “Single output/update
function” (the default). For more information about direct feed through,
see “Algebraic Loop Concepts”.

Generate a model_terminate
function for a model not designed to
run indefinitely.

Select Terminate function required. For more information, see the
description of model_terminate.

Generate reusable, reentrant code
from a model or subsystem.

Select Generate reusable code. See “Configure Code Reuse Support”
on page 48-10 for details.

Statically allocate model data
structures and access them directly in
the model code.

Clear Generate reusable code. The generated code is not reusable or
reentrant. See “Configure C Code Generation for Model Entry-Point
Functions” for information on the calling interface generated for model
functions in this case.

Suppress the generation of an error
status field in the real-time model
data structure, rtModel, for example,
if you do not require to log or monitor
error messages.

Select Remove error status field in real-time model data
structure. Selecting this parameter can also cause the code generator
to omit the rtModel structure from the generated code.

When generating code for multiple integrated models, set this
parameter the same for all of the models. Otherwise, the integrated
application could exhibit unexpected behavior. For example, if you
select the option in one model but not in another, it is possible that the
integrated application could not register the error status.

Do not select this parameter if you select the MAT-file logging option.
The two options are incompatible.

Open the Configure C Step Function
Interface dialog box and modify the
model_step function prototype.

In the Code Mapping Editor, on the Entry-Point Functions tab, click
in the Function Name column for the base-rate step function. Click the
three vertical dots that appear. Then click Configure Prototype.
Unless a function prototype was previously configured, the dialog box
opens showing a preview of the step function interface without
arguments (void-void). The dialog box also shows the current
function name. If arguments have previously been configured for the
model, the dialog box displays the current settings. You can change the
name and argument settings for the step function. For more
information, see “Configure Name and Arguments for Individual Step
Functions” on page 33-118.

For more information, see “Model Configuration Parameters: Code Generation Interface”.

Configure Code Reuse Support
For GRT, ERT, GRT-based, and ERT-based system target files, you can configure how a model reuses
code by setting the Code interface packaging configuration parameter value to Reusable
function.

The Pass root-level I/O as configuration parameter provides options that control how model inputs
and outputs at the root level of the model are passed to the model_step function.
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To... Select...
Pass each root-level model input and output argument
to the model_step function individually (the default)

Code interface packaging > Reusable function
and Pass root-level I/O as > Individual
arguments.

Pack root-level input arguments and root-level output
arguments into separate structures that are then
passed to the model_step function

Code interface packaging > Reusable function
and Pass root-level I/O as > Structure
reference.

Pack root-level input arguments and root-level output
arguments into the model data structure to support
reentrant multi-instance code from a model for ERT
system target file

Code interface packaging > Reusable function
and Pass root-level I/O as > Part of model data
structure.

If using the Code interface packaging > Reusable function selection, consider using the Use
dynamic memory allocation for model initialization option to control whether an allocation
function is generated. This option applies for ERT system target files.

Sometimes, selecting Code interface packaging as Reusable function can generate code that
compiles but is not reentrant. For example, if a signal, DWork structure, or parameter data has a
storage class other than Auto, global data structures are generated. To handle such cases, use the
Multi-instance code error diagnostic parameter to choose the severity levels for diagnostics.

Sometimes, the code generator is unable to generate valid and compilable code. For example, if the
model contains one of the following, the generated code is invalid.

• An S-function that is not code-reuse compliant
• A subsystem triggered by a wide function-call trigger

In these cases, the build terminates after reporting the problem.

For more information, see “Generate Reentrant Code from Top Models” on page 7-18 and “Model
Configuration Parameters: Code Generation Interface”.

See Also

More About
• “Configure a System Target File” on page 48-2
• “Configure a Code Replacement Library” on page 48-12
• “Configure Standard Math Library for Target System” on page 48-13
• “Compare System Target File Support Across Products” on page 48-16
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Configure a Code Replacement Library
You can configure the code generator to change the code that it generates for functions and
operators such that the code meets application requirements. Configure the code generator to apply
a code replacement library (CRL) during code generation. If you have Embedded Coder, you can
develop and apply custom code replacement libraries.

For more information about replacing code, using code replacement libraries that MathWorks
provides, see “What Is Code Replacement?” on page 55-2 and “Code Replacement Libraries”. For
information about developing code replacement libraries, see “What Is Code Replacement
Customization?” on page 67-3.

See Also

More About
• “Configure a System Target File” on page 48-2
• “Configure STF-Related Code Generation Parameters” on page 48-5
• “Configure Standard Math Library for Target System” on page 48-13
• “Compare System Target File Support Across Products” on page 48-16
• “Specify Generated Code Interfaces” on page 48-5
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Configure Standard Math Library for Target System
Specify standard library extensions that the code generator uses for math operations. When you
generate code for a new model or with a new configuration set object, the code generator uses the
ISO®/IEC 9899:1999 C (C99 (ISO)) library by default. For preexisting models and configuration set
objects, the code generator uses the library specified by the Standard math library parameter.

If your compiler supports the ISO®/IEC 9899:1990 (C89/C90 (ANSI)), ISO/IEC 14882:2003(C++03
(ISO) or ISO/IEC 14882:2011(C++11 (ISO)) math library extensions, you can change the standard
math library setting. The C++03 (ISO) or C++11 (ISO) library is an option when you select C++ for
the programming language.

The C99 library leverages the performance that a compiler offers over standard ANSI C. When using
the C99 library, the code generator produces calls to ISO C functions when possible. For example, the
generated code calls the function sqrtf(), which operates on single-precision data, instead of
sqrt().

To change the library setting, use the Configuration Parameters>Standard math library
parameter. The command-line equivalent is TargetLangStandard.

Generate and Inspect ANSI C Code

1. Open the example model rtwdemo_clibsup.

2. Generate code.

### Starting build procedure for: rtwdemo_clibsup
### Successful completion of code generation for: rtwdemo_clibsup
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Build Summary

Top model targets built:

Model            Action          Rebuild Reason                                    
===================================================================================
rtwdemo_clibsup  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 8.955s

3. Examine the code in the generated file rtwdemo_clibsup.c. Note that the code calls the sqrt
function.

  if (rtb_Abs2 < 0.0F) {
    rtb_Abs2 = -(real32_T)sqrt((real32_T)fabs(rtb_Abs2));
  } else {
    rtb_Abs2 = (real32_T)sqrt(rtb_Abs2);
  }

Generate and Inspect ISO C Code

1. Change the setting of Standard math library to C99 (ISO). Alternatively, at the command line,
set TargetLangStandard to C99 (ISO).

2. Regenerate the code.

### Starting build procedure for: rtwdemo_clibsup
### Successful completion of code generation for: rtwdemo_clibsup

Build Summary

Top model targets built:

Model            Action          Rebuild Reason                                    
===================================================================================
rtwdemo_clibsup  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 8.923s

3. Reexamine the code in the generated file rtwdemo_clibsup.c. Now the generated code calls the
function sqrtf instead of sqrt.

  if (rtb_Abs2 < 0.0F) {
    rtb_Abs2 = -sqrtf(fabsf(rtb_Abs2));
  } else {
    rtb_Abs2 = sqrtf(rtb_Abs2);
  }

Related Information

• “Standard math library”
• “Configure a System Target File”
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• “Configure STF-Related Code Generation Parameters”
• “Configure a Code Replacement Library”
• “Compare System Target File Support Across Products”
• “Replace Code Generated from Simulink Models”
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Compare System Target File Support Across Products
When you select a system target file (such as grt.tlc), the selection defines the run-time
environment and the code generation features. Identify the system target file features that match
your code generation workflow goals.

The code generator uses the system target file to produce code intended for execution on certain
target hardware or on a certain operating system. The system target file invokes other run-time
environment-specific files. For more information on configuring model code generation parameters
for target hardware, see “Configure Run-Time Environment Options”.

Different types of system target files support a selection of generated code features. In the system
target file, the value of the CodeFormat TLC variable and corresponding
rtwgensettings.DerivedFrom field value identify the system target file type and generated code
features. These selections apply your code generation control decisions at several points in the code
generation process. Your selections include whether and how the model build generates:

• Certain data structures (for example, SimStruct or rtModel)
• Static or dynamic memory allocation code
• Calling interface for generated model functions

For custom system target file development, the CodeFormat value differs among code generation
targets:

• If the system target file does not include a value for the CodeFormat TLC variable, the default
value is RealTime for generic real-time target (GRT). The corresponding
rtwgensettings.DerivedFrom field value is grt.tlc (default value).

• If you are developing a custom system target file and you have Embedded Coder software,
consider setting the CodeFormat TLC variable value to Embedded-C for embedded real-time
target (ERT). The corresponding rtwgensettings.DerivedFrom field value is ert.tlc. The
ERT system target file supports more generated code features than the GRT system target file.

This example shows how the value for the CodeFormat TLC variable and corresponding
rtwgensettings.DerivedFrom field value are set in ert.tlc.

%assign CodeFormat = "Embedded-C"

/%
  BEGIN_RTW_OPTIONS
  rtwgensettings.DerivedFrom = 'ert.tlc';
  END_RTW_OPTIONS
%/

Note Use the value for the CodeFormat TLC variable with its corresponding
rtwgensettings.DerivedFrom field value to generate code for the model. If you do not select a
value explicitly, the default values apply. For the rtwgensettings.DerivedFrom field, use
'ert.tlc' or 'grt.tlc'. For more information, see “System Target File Structure”.

For a description of the optimized call interface generated by default for the GRT and ERT system
target files, see “Configure C Code Generation for Model Entry-Point Functions”.

Code generation with the GRT and ERT system target files uses the real-time model data structure
(rtModel). This structure encapsulates model-specific information in a much more compact form
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than the simulation structure, SimStruct. Many efficient features of generated code depend on
generation of rtModel rather than SimStruct, including:

• Integer absolute and elapsed timing services
• Independent timers for asynchronous tasks
• Generation of improved C API code for signal, state, and parameter monitoring
• Pruning the data structure to minimize its size (ERT-derived system target files only)

For a description of the rtModeldata structure, see “Real-Time Model Data Structure” on page 34-
32.

Compare Product System Target Files
You can select from a range of system target files by using the System Target File Browser. This
selection lets you experiment with configuration options and save your model with different
configurations.

You cannot build or generate code for non-GRT system target files, unless you have the required
software on your system. For example, you require Embedded Coder for ERT system target files,
Simulink Desktop Real-Time for SLDRT system target files, and so on.

Selecting a system target file for your model selects either the toolchain approach or the template
makefile approach for build process control. For more information about these approaches, see
“Choose Build Approach and Configure Build Process” on page 57-11.
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System Target Files Available from System Target File Browser

Supported System Target File File Names Reference
Embedded Coder (for PC or UNIX
platforms)

ert.tlc
ert_shrlib.tlc

“Configure a System Target File” on page
48-2

Create Visual C++ Solution File
for Embedded Coder

ert.tlc

(Requires RTW.MSVCBuild as
TMF. See note.)

“Configure a System Target File” on page
48-2

Embedded Coder for AUTOSAR autosar.tlc “Develop a Model that Complies with the
AUTOSAR Standard” on page 23-18

Generic Real-Time (for PC or UNIX
platforms)

grt.tlc “Compare Generated Code Features by
STF” on page 48-22

Create Visual C++ Solution File grt.tlc

(Requires RTW.MSVCBuild as
TMF. See note.)

“Compare Generated Code Features by
STF” on page 48-22

Rapid Simulation (default for PC
or UNIX platforms)

rsim.tlc “Accelerate, Refine, and Test Hybrid
Dynamic System on Host Computer by
Using RSim System Target File” on page
63-2

Rapid Simulation for LCC compiler rsim.tlc “Accelerate, Refine, and Test Hybrid
Dynamic System on Host Computer by
Using RSim System Target File” on page
63-2

Rapid Simulation for UNIX
platforms

rsim.tlc “Accelerate, Refine, and Test Hybrid
Dynamic System on Host Computer by
Using RSim System Target File” on page
63-2

Rapid Simulation for Visual C++
compiler

rsim.tlc “Accelerate, Refine, and Test Hybrid
Dynamic System on Host Computer by
Using RSim System Target File” on page
63-2

S-Function for PC or UNIX
platforms

rtwsfcn.tlc “Accelerate Simulation, Reuse Code, or
Protect Intellectual Property by Using S-
Function Target”

S-Function for LCC rtwsfcn.tlc “Accelerate Simulation, Reuse Code, or
Protect Intellectual Property by Using S-
Function Target”

S-Function for UNIX platforms rtwsfcn.tlc “Accelerate Simulation, Reuse Code, or
Protect Intellectual Property by Using S-
Function Target”

S-Function for Visual C++
compiler

rtwsfcn.tlc “Accelerate Simulation, Reuse Code, or
Protect Intellectual Property by Using S-
Function Target”
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Supported System Target File File Names Reference
ASAM-ASAP2 Data Definition asap2.tlc

(Will be removed in a future
release. See “Generate ASAP2
and CDF Calibration Files” for
information about how to
generate A2L Files)

“Generate ASAP2 and CDF Calibration
Files”

Simulink Desktop Real-Time sldrt.tlc
sldrtert.tlc

“Set External Mode Code Generation
Parameters” (Simulink Desktop Real-Time)

Simulink Real-Time slrealtime.tlc “Simulink Real-Time Options Pane”
(Simulink Real-Time)

Note To create and build a Visual C++ Solution (.sln) file with Debug configuration, select
RTW.MSVCBuild in the “Template makefile” field.

Compare Code Styles and STF Support
The code generator produces two styles of code. One code style is suitable for rapid prototyping (and
simulation by using code generation). The other style is suitable for embedded applications. This
table maps system target files to corresponding code styles.

Code Styles Listed by System Target File 

System Target File Code Style Purpose
Embedded Coder embedded
real-time (ERT)

Embedded A starting point for embedded application
development of C/C++ generated code.

Simulink Coder generic real-
time (GRT)

Rapid prototyping A starting point for creating a rapid prototyping
target hardware that does not use real-time
operating system tasking primitives and for
verifying the generated C/C++ code on your
desktop computer.

Rapid simulation (RSim) Rapid prototyping Provides non-real-time simulation on your
desktop computer and a high-speed or batch
simulation tool.

S-function Rapid prototyping Creates a C MEX S-function for simulation within
another Simulink model.

Simulink Desktop Real-Time Rapid prototyping Runs a model in real time at interrupt level while
your desktop computer runs Microsoft Windows
in the background.

Simulink Real-Time Rapid prototyping Runs a model in real time on a desktop computer
running the Simulink Real-Time kernel.

Third-party vendors supply additional system target files to support code generation for their
products. For more information about third-party products, see the vendor website or the MathWorks
Connections program web page: https://www.mathworks.com/products/connections.
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Compare Generated Code Features by Product
The code generation process for real-time system target files (such as GRT) provides many embedded
code optimizations. Selecting an ERT-based system target file offers more extensive features than
GRT. The system target file selection determines the available features for the code generation
product. As you select the code generation target that matches your development process, use this
table to compare code generation features available with Simulink Coder and features available with
Embedded Coder.
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Compare Code Generation Features for Simulink Coder Versus Embedded Coder

Feature Simulink Coder Embedded Coder
rtModel data structure • Full rtModel structure generated

• GRT variable declaration:
rtModel_model model_M_;

• rtModel is optimized for the model
• Optional suppression of error status
field and data logging fields

• ERT variable declaration:
RT_MODEL_model model_M_;

Custom storage classes
(CSCs)

Code generation ignores CSCs. Objects
are assigned a CSC default to Auto
storage class.

Code generation with CSCs is supported

HTML code generation
report

Basic HTML code generation report Enhanced report with additional detail
and hyperlinks to the model

Symbol formatting Symbols (for signals, parameters, and so
on) are generated in accordance with
hard-coded default

Detailed control over generated symbols

User-defined maximum
identifier length for
generated symbols

Supported Supported

Generation of terminate
function

Generated Option to suppress the terminate
function

Combined output/update
function

Separate output/update functions are
generated

Option to generate combined output/
update function

Optimized data
initialization

Not available Options to suppress generation of
unnecessary initialization code for zero-
valued memory, I/O ports, and so on

Comments generation Basic options to include or suppress
comment generation

Options to include Simulink block
descriptions, Stateflow object
descriptions, and Simulink data object
descriptions in comments

Module Packaging
Features (MPF)

Not supported Extensive code customization features
See “Control Data Type Names in
Generated Code” on page 36-2 and “MPT
Data Object Properties” on page 37-2.

System target file-
optimized data types
header file

Requires full tmwtypes.h header file Generates optimized rtwtypes.h
header file, including definitions required
by the system target file

User-defined types User-defined types default to base types
in code generation

User-defined data type aliases are
supported in code generation

Rate grouping Not supported Supported
Auto-generation of main
program module

Not supported. Static main program
module is provided.

Automated and customizable generation
of main program module is supported
(static main program also available)

Reusable (multi-instance)
code generation

Option to generate reusable code with
dynamic memory allocation

Option to generate reusable code with
static or dynamic memory allocation
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Feature Simulink Coder Embedded Coder
Software constraint
options

Support for floating-point, complex, and
nonfinite numbers is enabled

Options to enable or disable support for
floating-point, complex, and nonfinite
numbers

Application life span Defaults to inf User-specified. Determines most efficient
word size for integer timers

ANSI-C/C++ code
generation

Supported Supported

ISO-C/C++ code
generation

Supported Supported

GNU®-C/C++ code
generation

Supported Supported

Generate scalar inlined
parameters as #DEFINE
statements

Not supported Supported

MAT-file variable name
modifier

Supported Supported

Data exchange: C API,
ASAP2, external mode

Supported Supported

Compare Generated Code Features by STF
The code generator supports a selection of generated code features for different types of system
target files. In each system target file, the value of the CodeFormat TLC variable identifies the set of
features.

This table summarizes how different system target files support applications.

Application System Target File (STF)
Fixed- or variable-step acceleration RSIM, S-Function, Model Reference
Fixed-step real-time deployment GRT, ERT, Simulink Real-Time, Simulink Desktop Real-

Time, ...

This table summarizes the various options available for each System target file selection, with the
exceptions noted.
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Features Supported in Code Generated for System Target Files (STF)

 System Target Files (STF)
Feature grt.tlc

(See
note
1.)

ert.tlc

(See
note
1.)

ert_shrlib.tlc

(See note 1.)

rtwsfcn.tlc

(See note 1.)

rsim.tlc

(See
note 1.)

sldrt.tlc

(See
note 1.)

slrealtim
e.tlc

(See
note 1.)

Other

(See
note 1.)

Static memory
allocation

X X    X X X

Dynamic
memory
allocation

X

(See
notes 4,
5.)

X

(See
notes 4,
5.)

 X X  X  

Continuous
time

X X  X X X X  

C/C++ MEX
S-functions
(noninlined)

X X  X X X X  

S-function
(inlined)

X X  X X X X X

Minimize
RAM/ROM
usage

 X     X2 X

Supports
external mode

X X   X X X  

Rapid
prototyping

X     X X X

Production
code

 X     X2 X

(See note
3.)

Batch
parameter
tuning and
Monte Carlo
methods

  X  X    

System-level
Simulator

  X      

Executes in
hard real time

X

(See
note 3.)

X

(See
note 3.)

   X X X5

Non-real-time
executable
included

X X   X    
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 System Target Files (STF)
Feature grt.tlc

(See
note
1.)

ert.tlc

(See
note
1.)

ert_shrlib.tlc

(See note 1.)

rtwsfcn.tlc

(See note 1.)

rsim.tlc

(See
note 1.)

sldrt.tlc

(See
note 1.)

slrealtim
e.tlc

(See
note 1.)

Other

(See
note 1.)

Multiple
instances of
model

X

(See
notes 4,
5.)

X

(See
notes 4,
5.)

 X4   X

(See notes
4, 5.)

X

(See notes
4, 5.)

Supports
variable-step
solvers

   X X    

Supports
SIL/PIL

X X      X

Notes

1 System Target Files:

• grt.tlc - generic real-time target
• ert.tlc - embedded real-time target
• ert_shrlib.tlc - embedded real-time target shared library)
• rtwsfcn.tlc - S-Function
• rsim.tlc - rapid simulation
• sldrt.tlc - Simulink Desktop Real-Time
• slrealtime.tlc - Simulink Real-Time
• Other - The embedded real-time capabilities in Simulink Coder support other system target
files

2 Does not apply to GRT-based system target files. Applies to only ERT-based system target files.
3 The default GRT and ERT rt_main files emulate execution of hard real time. When explicitly

connected to a real-time clock, they execute in hard real time.
4 You can generate code for multiple instances of a Stateflow chart or subsystem containing a

chart, except when the chart contains exported graphical functions or the Stateflow model
contains machine-parented events.

5 In the Configuration Parameters dialog box, for the Code interface packaging field, select
Reusable function.

See Also

More About
• “Configure a System Target File” on page 48-2
• “Configure STF-Related Code Generation Parameters” on page 48-5
• “Configure a Code Replacement Library” on page 48-12
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• “Configure Standard Math Library for Target System” on page 48-13
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Internationalization Support in
Embedded Coder

49



Internationalization and Code Generation
Internationalization support in software development tooling is vital to enabling efficient
globalization. If there is a remote possibility that you could collaborate in the future with others
across locales, consider internationalization from project inception. Internationalization can prevent
rework or having to develop a new model design. The relevant requirement concerns locale settings.

In this section...
“Locale Settings” on page 49-2
“Prepare to Generate Code for Mixed Languages and Locales” on page 49-2
“Character Set Limitations” on page 49-2
“XML Escape Sequence Replacements” on page 49-3
“CGT Files and XML Escape Sequence Replacements” on page 49-3
“Generate and Review Code with Mixed Languages and Mixed Locales” on page 49-3

Locale Settings
On a computer, a locale setting defines the language (character set encoding) for the user interface
and the display formats for information such as time, date, and currency. The encoding dictates the
number of characters that a locale can render. For example, the US-ASCII coded character set
(codeset) defines 128 characters. A Unicode® codeset, such as UTF-8, defines more than 1,100,000
characters.

For code generation, the locale setting determines the character set encoding of generated file
content. To avoid garbled text or incorrectly displayed characters, the locale setting for your MATLAB
session must be compatible with the setting for your compiler and operating system. For information
on finding and changing the operating system setting, see “Internationalization” or see the operating
system documentation.

To check a model for characters that cannot be represented in the locale setting of your current
MATLAB session, use the Simulink Model Advisor check “Check model for foreign characters”.

Prepare to Generate Code for Mixed Languages and Locales
To prepare to generate code for a model, identify:

• The operating system locale.
• The locale of the MATLAB session.
• Code generation requirements for:

• Target Language Compiler files
• Code generation template files that include comments (requires Embedded Coder)

Character Set Limitations
Target language compiler files support user default encoding only. To produce international, custom
generated code that is portable, use the 7-bit ASCII character set.
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XML Escape Sequence Replacements
The code generator replaces characters that are not represented in the character set encoding of a
model with XML escape sequences. Escape sequence replacements occur for block, signal, and
Stateflow object names that appear in:

• Generated code comments
• Code generation reports
• Block paths logged to MAT-files
• Block paths logged to C API files model_capi.c (or .cpp) and model_capi.h

CGT Files and XML Escape Sequence Replacements
The code generator replaces characters that are not represented in the character set encoding for a
model with XML escape sequences. Escape sequence replacements occur for block, signal, and
Stateflow object names that appear in Comments in code generation template (CGT) files.

By default, code generation template files do not contain character set encoding information. The
operating system reads the files, using its current encoding, regardless of the encoding that you use
to write the file. You can enable escape sequence replacements by adding the following token at the
top of the template file:

<encodingIn = "encoding">

Replace encoding with a string that names a standard character encoding scheme, such as UTF-8,
ISO-8859–1, or windows-1251.

This example shows content from the file rtwdemo_unicode.cgt in a MATLAB session for
windows-1251. The example uses the encodingIn token to set the encoding to UTF–8, which is the
correct value for code generation.

Generate and Review Code with Mixed Languages and Mixed Locales
This example shows how to use the code generator to produce and review code for use in mixed
languages and mixed locales.

 Internationalization and Code Generation
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Before using this example, see “Internationalization and Code Generation” or “Internationalization
and Code Generation” on page 49-2.

The rtwdemo_unicode model configuration uses the Embedded Coder (R) ert.tlc system target
file. To see internationalization and localization support with Simulink Coder®, configure the model
to use the grt.tlc system target file. The example indicates the support that is specific to
Embedded Coder® (for example, code generation templates).

The model configuration specifies files and settings that control how the code generator handles
localization for:

• C and C++ API interfaces
• Code generation template (CGT) files (requires Embedded Coder®)
• Target Language Compiler (TLC) files that apply code customizations (requires Embedded

Coder®)

Open the example model rtwdemo_unicode.

Open example model rtwdemo_unicode. Labels in the model appear in multiple languages (Arabic,
Chinese, English, German, and Japanese) and various Unicode symbols.

model = 'rtwdemo_unicode';
open_system(model);
%

Open the Embedded Coder App

In the Apps tab, select Embedded Coder.

Verify Locale Settings

Verify that the locale setting for your MATLAB® software is compatible with your compiler. See the
documentation for your operating system or the following MATLAB documentation:

• “Set Locale on Microsoft Windows Platforms”

49 Internationalization Support in Embedded Coder

49-4



• “Set Locale on Linux Platforms”
• “Set Locale on macOS Platforms”

Verify Model for Use of Foreign Characters

To verify the model for characters that the code generator cannot represent in the model's current
character set encoding, use the Simulink® Model Advisor check Check model for foreign
characters.

1. Open the Model Advisor. In the Modeling tab, click Model Advisor. Select Model Advisor. Or, in
the Command Window, type:

modeladvisor('rtwdemo_unicode')

Updating Model Advisor cache...
Model Advisor cache updated. For new customizations, to update the cache, use the Advisor.Manager.refresh_customizations method.

2. Expand By Product.

3. Expand Simulink.

4. Select Check model for foreign characters

5. Click Run This Check.

6. Review the results. Several warnings appear. Verify that the characters in the model can be
represented in the current character set encoding.

7. Close the Model Advisor.

Code Generation Template Files

To use a code generation template file with unicode characters when generating code, complete these
steps (requires Embedded Coder®). Otherwise, go to the next section.

1. Open the Configuration Parameters dialog box.

2. Navigate to the Code Generation > Template pane. The model is configured to use the code
generation template file rtwdemo_unicode.cgt. That file adds comments to the top of generated
code files. For the code generator to apply escape sequence replacements for the .cgt file, enable
replacements by specifying:

<encodingIn = "encoding-name">

3. Open the file /toolbox/rtw/rtwdemos/rtwdemo_unicode.cgt.

edit rtwdemo_unicode.cgt

4. Find the line of code that enables escape sequence replacements for the character set encoding
UTF-8.

<encodingIn = "UTF-8">

5. Close the file /toolbox/rtw/rtwdemos/rtwdemo_unicode.cgt.
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Generated File Customization Template

To use file customization templates with unicode characters when generating code, complete these
steps (requires Embedded Coder®). Otherwise, go to the next section.

You can specify customizations to generated code files by using TLC code. TLC files support user
default encoding only. To produce international custom generated code that is portable, use the 7-bit
ASCII character set.

1. Open the Configuration Parameters dialog box.

2. Navigate to the Code Generation > Template pane. The model is configured to use the code
customization file example_file_process.tlc. That file customizes the generated code just
before the code generator writes the code files. For example, the file adds a C source file,
corresponding include file, and #define and #include statements.

3. Open the file /toolbox/rtw/rtwdemos/example_file_process.tlc.

edit example_file_process.tlc

4. Before generating code, uncomment the following line of code:

%% %assign ERTCustomFileTest = TLC_TRUE%

5. Close the file /toolbox/rtw/rtwdemos/example_file_process.tlc.

Generate C Code and a Report

Generate C code and a code generation report.

evalc('slbuild(''rtwdemo_unicode'')');

Review the Generated Code

For characters that are not in the current MATLAB® character set encoding, the code generator uses
escape sequence replacements to render characters correctly in the code generation report.

1. If the code generation report for model rtwdemo_unicode is not open, in the Command Window,
type:

coder.report.open('rtwdemo_unicode')

2. Review the generated code in rtwdemo_unicode.c and rtwdemo_unicode.h. Names of model
elements appear in code comments as replacement names in the local language.

3. Open the Traceability Report. The report maintains traceability information, even when the name
contains characters that are not represented in the current encoding. Names of model elements
appear in the report as replacement names in the local language.

4. Scroll down to and click the code location link for the first Chart (State 'Selection'
<S2>:23). The report view changes to show the corresponding code in rtwdemo_unicode.c.

5. In the code comment, click the <S2>:23 link. The model window shows the chart in a new tab.

6. In the model window, right-click that chart. From the context menu, select C/C++ Code >
Navigate to C/C++ Code. The report view changes to show the named constant section of code for
that chart.
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7. Close the code generation report, Model Advisor, and model. In the Command Window, type:

coder.report.close();
bdclose('all');

Generate C++ Code

Generate C++ code and a code generation report.

1. Open the model.

model = 'rtwdemo_unicode';
open_system(model);

2. Set model configuratoin parameter Language to C++. Or, in the Command Window, type:

set_param('rtwdemo_unicode','TargetLang','C++');

3. Set model configuration parameter Code interface packaging to C++ class. Or, in the
Command Window, type:

set_param('rtwdemo_unicode','CodeInterfacePackaging','C++ class');

4. Generate C++ code and a code generation report.

evalc('rtwrebuild(''rtwdemo_unicode'')');

5. To see internationalization and localization support, review the generated code. See Review the
Generated Code.

6. Close the code generation report and model. In the Command Window, type:
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coder.report.close();
bdclose('all');

See Also

More About
• “Locale Setting Concepts for Internationalization”

49 Internationalization Support in Embedded Coder

49-8



Source Code Generation in Simulink
Coder

• “Configure Model, Generate Code, and Simulate” on page 50-2
• “Configure Model and Generate Code” on page 50-11
• “Configure Data Interface” on page 50-16
• “Call External C Functions” on page 50-23
• “Reload Generated Code” on page 50-29
• “Manage Build Process Folders” on page 50-30
• “Manage Build Process Files” on page 50-34
• “Manage Build Process File Dependencies” on page 50-41
• “Add Build Process Dependencies” on page 50-50
• “Build Process Support for Folder Names with Spaces or Special Characters” on page 50-55
• “Code Generation of Matrices and Arrays” on page 50-60
• “Cross-Release Shared Utility Code Reuse” on page 50-66
• “Cross-Release Code Integration” on page 50-68
• “Integration of Code from Multiple Folders” on page 50-79
• “Integrate Generated Code by Using Cross-Release Workflow” on page 50-82
• “Use Protected Models from Previous Releases to Perform SIL Testing and Generate Code”

on page 50-90
• “Compile Code in Another Development Environment” on page 50-96
• “Generate Code and Simulate Models in a Project” on page 50-99
• “Generate Code and Simulate Models Programmatically with Project” on page 50-102

50



Configure Model, Generate Code, and Simulate
In this section...
“About This Example” on page 50-2
“Functional Design of the Model” on page 50-2
“View the Top Model” on page 50-2
“View the Subsystems” on page 50-3
“Simulation Test Environment” on page 50-4
“Run Simulation Tests” on page 50-8
“Key Points” on page 50-9
“Learn More” on page 50-10

About This Example
Learning Objectives

• Learn about the functional behavior of the example model.
• Learn about the role of the example test harness and its components.
• Run simulation tests on a model.

Prerequisites

• Ability to open and modify Simulink models and subsystems.
• Understand subsystems and how to view subsystem details.
• Understand referenced models and how to view referenced model details.
• Ability to set model configuration parameters.

Required Files

Before you use each example model file, place a copy in a writable location and add it to your
MATLAB path.

• rtwdemo_throttlecntrl model file
• rtwdemo_throttlecntrl_testharness model file

Functional Design of the Model
This example uses a simple, but functionally complete, example model of a throttle controller. The
model features redundant control algorithms. The model highlights a standard model structure and a
set of basic blocks in algorithm design.

View the Top Model
Open rtwdemo_throttlecntrl and save a copy as throttlecntrl in a writable location on your
MATLAB path.
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Note This model uses Stateflow software.

The top level of the model consists of the following elements:

Subsystems PI_ctrl_1
PI_ctrl_2
Define_Throt_Param
Pos_Command_Arbitration

Top-level input pos_rqst
fbk_1
fbk_2

Top-level output pos_cmd_one
pos_cmd_two
ThrotComm1

Signal routing  
Omit blocks that change the value of a signal,
such as Sum and Integrator

 

The layout uses a basic architectural style for models:

• Separation of calculations from signal routing (lines and buses)
• Partitioning into subsystems

You can apply this style to a wide range of models.

View the Subsystems
Explore two of the subsystems in the top model.

1 If not already open, open throttlecntrl.

Two subsystems in the top model represent proportional-integral (PI) controllers, PI_ctrl_1
and PI_ctrl_2. At this stage, these identical subsystems, use identical data.

2 Open the PI_ctrl_1 subsystem.
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The PI controllers in the model are from a library, a group of related blocks or models for reuse.
Libraries provide one of two methods for including and reusing models. The second method,
model referencing, is described in “Simulation Test Environment” on page 50-4. You cannot
edit a block that you add to a model from a library. Edit the block in the library so that instances
of the block in different models remain consistent.

3 Open the Pos_Command_Arbitration subsystem. This Stateflow chart performs basic error
checking on the two command signals. If the command signals are too far apart, the Stateflow
diagram sets the output to a fail_safe position.

4 Close throttlecntrl.

Simulation Test Environment
To test the throttle controller algorithm, incorporate it into a test harness. A test harness is a model
that evaluates the control algorithm and offers the following benefits:

• Separates test data from the control algorithm.
• Separates the plant or feedback model from the control algorithm.
• Provides a reusable environment for multiple versions of the control algorithm.

The test harness model for this example implements a common simulation testing environment
consisting of the following parts:
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• Unit under test
• Test vector source
• Evaluation and logging
• Plant or feedback system
• Input and output scaling

Explore the simulation testing environment.

1 Open the test harness model rtwdemo_throttlecntrl_testharness and save a copy as
throttlecntrl_testharness in a writable location on your MATLAB path.

2 Set up your throttlecntrl model as the control algorithm of the test harness.

a Open the Unit_Under_Test block and view the control algorithm.
b View the model reference parameters by right-clicking the Unit_Under_Test block and

selecting Block Parameters (ModelReference).
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rtwdemo_throttlecntrl appears as the name of the referenced model.
c Change the value of Model name to throttlecntrl.
d Update the test harness model diagram by clicking Simulation > Update Diagram.

The control algorithm is the unit under test, as indicated by the name of the Model block,
Unit_Under_Test.

The Model block provides a method for reusing components. From the top model, it allows you to
reference other models (directly or indirectly) as compiled functions. By default, Simulink
software recompiles the model when the referenced models change. Compiled functions have the
following advantages over libraries:

• Simulation time is faster for large models.
• You can directly simulate compiled functions.
• Simulation requires less memory. Only one copy of the compiled model is in memory, even

when the model is referenced multiple times.
3 Open the test vector source, implemented in this test harness as the Test_Vectors subsystem.

50 Source Code Generation in Simulink Coder

50-6



The subsystem uses a Signal Builder block for the test vector source. The block has data that
drives the simulation (PosRequest) and provides the expected results used by the
Verification subsystem. This example test harness uses only one set of test data. Typically,
create a test suite that fully exercises the system.

4 Open the evaluation and logging subsystem, implemented in this test harness as subsystem
Verification.

A test harness compares control algorithm simulation results against golden data — test results
that exhibit the desired behavior for the control algorithm as certified by an expert. In the
Verification subsystem, an Assertion block compares the simulated throttle value position
from the plant against the golden value from the test harness. If the difference between the two
signals is greater than 5%, the test fails and the Assertion block stops the simulation.

Alternatively, you can evaluate the simulation data after the simulation completes execution.
Perform the evaluation with either MATLAB scripts or third-party tools. Post-execution evaluation
provides greater flexibility in the analysis of data. However, it requires waiting until execution is
complete. Combining the two methods can provide a highly flexible and efficient test
environment.

5 Open the plant or feedback system, implemented in this test harness as the Plant subsystem.
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The Plant subsystem models the throttle dynamics with a transfer function in canonical form.
You can create plant models to varying levels of fidelity. It is common to use different plant
models at different stages of testing.

6 Open the input and output scaling subsystems, implemented in this test harness as
Input_Signal_Scaling and Output_Signal_Scaling.

The subsystems that scale input and output perform the following primary functions:

• Select input signals to route to the unit under test.
• Select output signals to route to the plant.
• Rescale signals between engineering units and units that are writable for the unit under test.
• Handle rate transitions between the plant and the unit under test.

7 Save and close throttlecntrl_testharness.

Run Simulation Tests
1 Check that your working folder is set to a writable folder, such as the folder into which you

placed copies of the example model files.
2 Open your copy of the test harness model, throttlecntrl_testharness.
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3 Start a test harness model simulation. When the simulation is complete, the following results
appear.

The lower-right hand plot shows the difference between the expected (golden) throttle position
and the throttle position that the plant calculates. If the difference between the two values is
greater than ±0.05, the simulation stops.

4 Save and close throttle controller and test harness models.

Key Points
• A basic model architecture separates calculations from signal routing and partitions the model

into subsystems
• Two options for model reuse include block libraries and model referencing.
• If you represent your control algorithm in a test harness as a Model block, specify the name of the

control algorithm model in the Model Reference Parameters dialog box.
• A test harness is a model that evaluates a control algorithm. Typically, a harness consists of a unit

under test, a test vector source, evaluation and logging, a plant or feedback system, and input and
output scaling components.

• The unit under test is the control algorithm being tested.
• The test vector source provides the data that drives the simulation which generates results used

for verification.
• During verification, the test harness compares control algorithm simulation results against golden

data and logs the results.
• The plant or feedback component of a test harness models the environment that is being

controlled.
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• When developing a test harness,

• Scale input and output components.
• Select input signals to route to the unit under test.
• Select output signals to route to the plant.
• Rescale signals between engineering units and units that are writable for the unit under test.
• Handle rate transitions between the plant and the unit under test.

• Before running simulation or completing verification, consider checking a model with the Model
Advisor.

Learn More
• “Support Model Referencing”
• “Code Generation”
• “Signal Groups”
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Configure Model and Generate Code
In this section...
“About This Example” on page 50-11
“Configure the Model for Code Generation” on page 50-11
“Save Your Model Configuration as a MATLAB Function” on page 50-12
“Check Model Conditions and Configuration Settings” on page 50-13
“Generate Code for the Model” on page 50-13
“Review the Generated Code” on page 50-13
“Generate an Executable” on page 50-14
“Key Points” on page 50-14

About This Example
Learning Objectives

• Configure a model for code generation.
• Apply model checking tools to discover conditions and configuration settings resulting in

generation of inaccurate or inefficient code.
• Generate code from a model.
• Locate and identify generated code files.
• Review generated code.

Prerequisites

• Ability to open and modify Simulink models and subsystems.
• Ability to set model configuration parameters.
• Ability to use the Simulink Model Advisor.
• Ability to read C code.
• An installed, supported C compiler.

Required Files

rtwdemo_throttlecntrl model file

Configure the Model for Code Generation
Model configuration parameters determine the method for generating the code and the resulting
format.

1 Open rtwdemo_throttlecntrl and save a copy as throttlecntrl in a writable location on
your MATLAB path. Then, open the Simulink Coder app.

2 Open the Configuration Parameters dialog box, Solver pane. To generate code for a model, you
must configure the model to use a fixed-step solver. The following table shows the solver
configuration for this example.
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Parameter Setting Effect on Generated Code
Type Fixed-step Maintains a constant (fixed)

step size, which is required
for code generation

Solver discrete (no
continuous states)

Applies a fixed-step
integration technique for
computing the state
derivative of the model

Fixed-step size .001 Sets the base rate; must be
the lowest common multiple
of the rates in the system

3 Set model configuration parameter System target file to grt.tlc.

Note The GRT (Generic Real-Time Target) configuration requires a fixed-step solver. However,
the rsim.tlc system target file supports variable step code generation.

The system target file defines an environment for generating and building code for execution on
a certain hardware or operating system platform. For example, one property of a system target
file is the value for the CodeFormat TLC variable. The GRT configuration requires a fixed step
solver and the rsim.tlc supports variable step code generation.

4 Set model configuration parameter Include directories as follows:

"$matlabroot$\toolbox\rtw\rtwdemos\EmbeddedCoderOverview\"

This folder includes files that are required to build an executable for the model.
5 Close the Model Configuration Parameters dialog box.

Save Your Model Configuration as a MATLAB Function
You can save the settings of model configuration parameters as a MATLAB function by using the
getActiveConfigSet function. In the MATLAB Command Window, enter:

thcntrlAcs = getActiveConfigSet('throttlecntrl');
thcntrlAcs.saveAs('throttlecntrlModelConfig');

You can then use the resulting function (for example, throttlecntrlModelConfig) to:

• Archive the model configuration.
• Compare different model configurations by using differencing tools.
• Set the configuration of other models.

50 Source Code Generation in Simulink Coder

50-12



For example, you can set the configuration of model myModel to match the configuration of the
throttle controller model by opening myModel and entering:

myModelAcs = throttlecntrlModelConfig;
attachConfigSet('myModel', myModelAcs, true);
setActiveConfigSet('myModel', myModelAcs.Name);

For more information, see “Save a Configuration Set” and “Load a Saved Configuration Set”.

Check Model Conditions and Configuration Settings
Before generating code for a model, use the Simulink Model Advisor to check the model for
conditions and configuration settings. This check finds issues that can result in inaccurate or
inefficient code.

1 Open model throttlecntrl. Then, open the Simulink Coder app.
2 Start the Model Advisor. In the C Code tab, click C/C++ Code Advisor. A dialog box opens

showing the model system hierarchy.
3 Click rtwdemo_throttlecntrl and then click OK. The Model Advisor window opens.
4 In the right pane, select Run this check. The report shows a Run Summary that flags check

warnings.
5 Review the report. The warnings highlight issues. At this point, you can ignore them. For more

information about reports, see “View Model Advisor Check Reports”.

Generate Code for the Model
1 Open throttlecntrl. Then, open the Simulink Coder app.
2 Select model configuration parameter Generate code only.
3 Select model configuration parameter Create code generation report and click Apply.
4 Generate code.

Messages appear in the Diagnostics Viewer. The code generator produces standard C and header
files, and an HTML code generation report. The code generator places the files in a build folder,
a subfolder named throttlecntrl_grt_rtw under your current working folder.

Review the Generated Code
1 In the code generation report, click the link for the generated C model file and review the

generated code. Look for these items in the report:

• Identification, version, timestamp, and configuration comments.
• Links to help you navigate within and between files
• Data definitions
• Scheduler code
• Controller code
• Model initialization and termination functions
• Call interface for the GRT system target file — output, update, initialization, start, and

terminate
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2 Save and close model throttlecntrl.

Consider examining the following files. In the code generation report Contents pane, click the links.

File Description
throttlecntrl.c C file that contains the scheduler, controller,

initialization, and interface code
throttlecntrl_data.c C file that assigns values to generated data

structures
throttlecntrl.h Header file that defines data structures
throttlecntrl_private.h Header file that defines data used only by the

generated code
throttlecntrl_types.h Header file that defines the model data structure

For more information, see “Manage Build Process File Dependencies”.

At this point, consider logging data to a MAT-file. For an example, see “Log Data for Analysis”.

Generate an Executable
1 Open throttlecntrl. Then, open the Simulink Coder app.
2 Clear model configuration parameter Generate code only and click Apply.
3 Build the model. Watch the messages in the Diagnostics Viewer. The code generator uses a

template make file associated with your system target file selection to create an executable file.
You can run this program on your workstation, independent of external timing and events.

4 Check your working folder for the file throttlecntrl.exe.
5 Run the executable. In the Command Window, enter !throttlecntrl. The ! character passes

the command that follows it to the operating system, which runs the standalone program.

The program produces one line of output in the Command Window:

** starting the model **

At this point, consider logging data to a MAT-file. For an example, see “Log Data for Analysis”.

Tip For UNIX platforms, run the executable program in the Command Window with the syntax !./
executable_name. If preferred, run the executable program from an OS shell with the syntax ./
executable_name. For more information, see “Run External Commands, Scripts, and Programs”.

Key Points
• To generate code, change the model configuration to specify a fixed-step solver then select a

system target file. Using the grt.tlc file requires a fixed-step solver. If the model contains
continuous time blocks, you can use a variable-step solver with the rsim.tlc system target file.

• After debugging a model, consider configuring a model with parameter inlining enabled.
• Use the getActiveConfigSet function to save a model configuration for future use or to apply it

to another model.

50 Source Code Generation in Simulink Coder

50-14



• Before generating code, consider checking a model with the Model Advisor.
• The code generator places generated files in a subfolder (model_grt_rtw) of your working folder.

See Also

More About
• “Code Generation”
• “Model Configuration Sets”
• “Check Your Model Using the Model Advisor”
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Configure Data Interface

About This Example
Learning Objectives

• Configure the data interface for code generated for a model.
• Control the name, data type, and data storage class of signals and parameters in generated code.

Prerequisites

• Understanding ways to represent and use data and signals in models.
• Familiarity with representing data constructs as data objects.
• Ability to read C code.

Required File

rtwdemo_throttlecntrl_datainterface model file

Declare Data
Most programming languages require that you declare data before using it. The declaration specifies
the following information:

Data Attribute Description
Scope The region of the program that has access to the data
Duration The period during which the data is resident in memory
Data type The amount of memory allocated for the data
Initialization An initial value, a pointer to memory, or NULL. If you do not provide an initial

value, most compilers assign a zero value or a null pointer.

The following data types are supported for code generation.

Supported Data Types

Name Description
double Double-precision floating point
single Single-precision floating point
int8 Signed 8-bit integer
uint8 Unsigned 8-bit integer
int16 Signed 16-bit integer
uint16 Unsigned 16-bit integer
int32 Signed 32-bit integer
uint32 Unsigned 32-bit integer
Fixed-point data types 8-, 16-, 32-bit word lengths
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A storage class is the scope and duration of a data item. For more information about storage classes,
see “C Code Generation Configuration for Model Interface Elements” on page 33-2.

Use Data Objects
In Simulink models and Stateflow charts, the following methods are available for declaring data: data
objects and direct specification. This example uses the data object method. Both methods allow full
control over the data type and storage class. You can mix the two methods in a single model.

In the MATLAB and Simulink environment, you can use data objects in various ways. This example
focuses on the following types of data objects:

• Signal
• Parameter
• Bus

To configure the data interface for your model using the data object method, in the MATLAB base
workspace, you define data objects. Then, associate them with your Simulink model or embedded
Stateflow chart. When you build your model, the build process uses the associated base workspace
data objects in the generated code.

You can set the values of the data object properties, which include:

• Data type
• Storage class
• Value (parameters)
• Initial value (signals)
• Identifier (define a different name in the generated code)
• Dimension (typically inherited for parameters)
• Complexity (inherited for parameters)
• Unit (physical measurement unit)
• Minimum value
• Maximum value
• Description (used to document your data objects — does not affect simulation or code generation)

You can create and inspect base workspace data objects by entering commands in the MATLAB
Command Window or by using Model Explorer. To explore base workspace signal data objects, use
these steps:

1 Open rtwdemo_throttlecntrl_datainterface and save a copy as
throttlecntrl_datainterface in a writable location on your MATLAB path.

2 Open Model Explorer.
3 Select Base Workspace.
4 Select the pos_cmd_one signal object for viewing.
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You can also view the definition of a signal object. In the MATLAB Command Window, enter
pos_cmd_one:

pos_cmd_one =
 
Signal with properties:

       CoderInfo: [1x1 Simulink.CoderInfo]
     Description: 'Throttle position command from the first PI controller'
        DataType: 'double'
             Min: -1
             Max: 1
            Unit: ''
      Dimensions: -1
  DimensionsMode: 'auto'
      Complexity: 'auto'
      SampleTime: -1
    InitialValue: '0'

5 To view other signal objects, in Model Explorer, click the object name or in the MATLAB
Command Window, enter the object name. This table summarizes object characteristics for some
of the data objects in this model.

Object
Characteristics

pos_cmd_one pos_rqst P_InErrMap ThrotComm* ThrottleCommands*

Description Top-level
output

Top-level
input

Calibration
parameter

Top-level
output
structure

Bus definition

Data type Double Double Auto Auto Structure
Storage class Exported

global
Imported
extern
pointer

Constant Exported
global

None

* ThrottleCommands defines a Bus object; ThrotComm is an instantiation of the bus. If the bus
is a nonvirtual bus, the signal generates a structure in the C code.
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You can use a bus definition (ThrottleCommands) to instantiate multiple instances of the structure.
In a model diagram, a bus object appears as a wide line with central dashes, as shown.

Add New Data Objects
You can create data objects for named signals, states, and parameters. To associate a data object with
a construct, the construct must have a name.

To find constructs for which you can create data objects, use the Data Object Wizard. This tool finds
the constructs and then creates the objects for you. The model includes two signals that are not
associated with data objects: fbk_1 and pos_cmd_two.

To find the signals and create data objects for them:

1 In the Simulink Editor, in the Modeling tab, under Design, click Data Object Wizard. The Data
Object Wizard dialog box opens.

2 To find candidate constructs, click Find. Constructs fbk_1 and pos_cmd_two appear in the
dialog box.

3 To select both constructs, click Select All.
4 In the table, under Class, make sure that each proposed data object uses the class

Simulink.Signal. To change the class of the objects, click Change Class.
5 To create the data objects, click Create. Constructs fbk_1 and pos_cmd_two are removed from

the dialog box.
6 Close the Data Object Wizard.
7 In the Contents pane of the Model Explorer, find the newly created objects fbk_1 and

pos_cmd_two.

Enable Data Objects for Generated Code
1 Enable a signal to appear in generated code.

a In the Simulink Editor, right-click the pos_cmd_one signal line and select Properties. A
Signal Properties dialog box opens.

b Make sure that you select the Signal name must resolve to Simulink signal object
parameter.
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2 Enable signal object resolution for the signals in the model. In the MATLAB Command Window,
enter:

disableimplicitsignalresolution('throttlecntrl_datainterface')
3 Save and close throttlecntrl_datainterface.

Effects of Simulation on Data Typing
In the throttle controller model, the data types are set to double. Because Simulink software uses
the double data type for simulation, do not expect changes in the model behavior when you run the
generated code. You verify this effect by running the test harness.

Before you run your test harness, update it to include the throttlecntrl_datainterface model.

Note The following procedure requires a Stateflow license.

1 Open throttlecntrl_datainterface.
2 Open your copy of test harness, throttlecntrl_testharness.
3 Right-click the Unit_Under_Test Model block and select Block Parameters

(ModelReference).
4 Set Model name to throttlecntrl_datainterface. Click OK.
5 Update the test harness model diagram.
6 Simulate the test harness.

The resulting plot shows that the difference between the golden and simulated versions of the
model remains zero.
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7 Save and close throttlecntrl_testharness.

Manage Data
Data objects exist in a separate file from the model in the base workspace. To save the data manually,
in the MATLAB Command Window, enter save.

The separation of data from the model provides the following benefits:

• One model, multiple data sets:

• Use of different parameter values to change the behavior of the control algorithm (for example,
for reusable components with different calibration values)

• Use of different data types to change targeted hardware (for example, for floating-point and
fixed-point targeted hardware)

• Multiple models, one data set:

• Sharing data between models in a system
• Sharing data between projects (for example, transmission, engine, and wheel controllers can

use the same CAN message data set)
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Key Points
• You can declare data in Simulink models and Stateflow charts by using data objects or direct
specification.

• From the Model Explorer or from the command line in the MATLAB Command Window, manage
(create, view, configure, and so on) base workspace data.

• The Data Object Wizard provides a quick way to create data objects for constructs such as signals,
buses, and parameters.

• Configure data objects explicitly to appear by name in generated code.
• Separation of data from model provides several benefits.

See Also

More About
• “Load Signal Data for Simulation”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Control Placement of Global Data Definitions and Declarations in Generated Files” on page 35-

2
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Call External C Functions
In this section...
“About This Example” on page 50-23
“Include External C Functions in a Model” on page 50-23
“Create a Block That Calls a C Function” on page 50-23
“Validate External Code in the Simulink Environment” on page 50-25
“Validate C Code as Part of a Model” on page 50-26
“Call a C Function from Generated Code” on page 50-27
“Key Points” on page 50-27

About This Example
Learning Objectives

• Evaluate a C function as part of a model simulation.
• Call an external C function from generated code.

Prerequisites

• Ability to open and modify Simulink models and subsystems.
• Ability to set model configuration parameters.
• Ability to read C code.
• An installed, supported C compiler.

Required Files

• rtwdemo_throttlecntrl_extfunccall model file
• rtwdemo_ValidateLegacyCodeVrsSim model file
• /toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_4_files/SimpleTable.c
• /toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_4_files/SimpleTable.h

Include External C Functions in a Model
Simulink models are one part of Model-Based Design. For many applications, a design also includes a
set of pre-existing C functions created, tested (verified), and validated outside of a MATLAB and
Simulink environment. You can integrate these functions easily into a model and the generated code.
You can use external C code in the generated code to access hardware devices and external data files
during rapid simulation runs.

This example shows you how to create a custom block that calls an external C function. When the
block is part of the model, you can take advantage of the simulation environment to test the system
further.

Create a Block That Calls a C Function
To specify a call to an external C function, use an S-Function block. You can automate the process of
creating the S-Function block by using the Simulink Legacy Code Tool. Using this tool, specify an
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interface for your external C function. The tool then uses that interface to automate creation of an S-
Function block.

1 Make copies of the files SimpleTable.c and SimpleTable.h, located in the folder
matlabroot/toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_4_files (open).
Put the copies in your working folder.

2 Create an S-Function block that calls the specified function at each time step during simulation:

a In the MATLAB Command Window, create a function interface definition structure:

def=legacy_code('initialize')

The data structure def defines the function interface to the external C code.

def = 

                  SFunctionName: ''
    InitializeConditionsFcnSpec: ''
                  OutputFcnSpec: ''
                   StartFcnSpec: ''
               TerminateFcnSpec: ''
                    HeaderFiles: {}
                    SourceFiles: {}
                   HostLibFiles: {}
                 TargetLibFiles: {}
                       IncPaths: {}
                       SrcPaths: {}
                       LibPaths: {}
                     SampleTime: 'inherited'
                        Options: [1x1 struct]

b Populate the function interface definition structure by entering the following commands:

def.OutputFcnSpec=['double y1 = SimpleTable(double u1,',...
   'double p1[], double p2[], int16 p3)'];
def.HeaderFiles = {'SimpleTable.h'};
def.SourceFiles = {'SimpleTable.c'};
def.SFunctionName = 'SimpTableWrap';

c Create the S-function:

legacy_code('sfcn_cmex_generate', def)
d Compile the S-function:

legacy_code('compile', def)
e Create the S-Function block:

legacy_code('slblock_generate', def)

A new model window opens that contains the SimpTableWrap block.

Tip Creating the S-Function block is a one-time task. Once the block exists, you can reuse it
in multiple models.

3 Save the model to your working folder as: s_func_simptablewrap.
4 Create a Target Language Compiler (TLC) file for the S-Function block:

legacy_code('sfcn_tlc_generate', def)
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The TLC file is the component of an S-function that specifies how the code generator produces
the code for a block.

For more information on using the Legacy Code Tool, see:

• “Integrate C Functions Using Legacy Code Tool”
• “Import Calls to External Code into Generated Code with Legacy Code Tool”

Validate External Code in the Simulink Environment
When you integrate external C code with a Simulink model, before using the code, validate the
functionality of the external C function code as a standalone component.

1 Open the model rtwdemo_ValidateLegacyCodeVrsSim. This model validates the S-function
block that you created.

• The Sine Wave block produces output values from [-2 : 2].
• The input range of the lookup table is from [-1 : 1].
• The output from the lookup table is the absolute value of the input.
• The lookup table output clips the output at the input limits.

2 Simulate the model.
3 View the validation results by opening the Validation subsystem and, in that subsystem,

clicking the Scope block.

The following figure shows the validation results. The external C code and the Simulink Lookup
table block provide the same output values.
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4 Close the validation model.

Validate C Code as Part of a Model
After you validate the functionality of the external C function code as a standalone component,
validate the S-function in the model. Use the test harness model to complete the validation.

Note The following procedure requires a Stateflow license.

1 Open rtwdemo_throttlecntrl_extfunccall and save a copy to
throttlecntrl_extfunccall in a writable folder on your MATLAB path.

2 Examine the PI_ctrl_1 and PI_ctrl_2 subsystems.

a Lookup blocks have been replaced with the block you created using the Legacy Code Tool.
b Examine the block parameter settings for SimpTableWrap and SimpTableWrap1.
c Close the Block Parameter dialog boxes and the PI subsystem windows.

3 Open the test harness model, right-click the Unit_Under_Test Model block, and select Block
Parameters (ModelReference).

4 Set Model name to throttlecntrl_extfunccall. Click OK.
5 Update the test harness model diagram.
6 Simulate the test harness.

The simulation results match the expected golden values.
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7 Save and close throttlecntrl_extfunccall and throttlecntrl_testharness.

Call a C Function from Generated Code
The code generator uses a TLC file to process the S-Function block. Calls to C code embedded in an
S-Function block:

• Can use data objects.
• Are subject to expression folding, an operation that combines multiple computations into a single

output calculation.

1 Open throttlecntrl_extfunccall.
2 Generate code for the model.
3 Examine the generated code in the filethrottlecntrl_extfunccall.c.
4 Close throttlecntrl_extfunccall and throttlecntrl_testharness.

Key Points
• You can easily integrate external functions into a model and generated code by using the Legacy

Code Tool.
• Validate the functionality of external C function code which you integrate into a model as a

standalone component.
• After you validate the functionality of external C function code as a standalone component,

validate the S-function in the model.
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See Also

More About
• “Integrate C Functions Using Legacy Code Tool”
• “S-Functions and Code Generation”
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Reload Generated Code
You can reload the code generated for a model from the Model Explorer.

1 Click the Code for model node in the Model Hierarchy pane.
2 In the Code pane, click the Refresh link.

The code generator reloads the code for the model from the build folder.

See Also

More About
• “Rebuild a Model”
• “Control Regeneration of Top Model Code”
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Manage Build Process Folders
The build process places generated files from Simulink diagram updates and model builds into a
hierarchy of folders that is specified by default. You can change the default specification for build
process folders, if, for example:

• Your company does not use the current working folder as the location for the code generation
folder or the simulation cache folder.

• You place the code generation folder under version control, but do not place the simulation cache
folder under version control.

The MATLAB session parameters CacheFolder, CodeGenFolder, and CodeGenFolderStructure
are file generation control parameters that specify the folder locations for the build process. At the
start of a MATLAB session, these Simulink preferences determine the values of the parameters:

Simulation cache folder – CacheFolder

Code generation folder – CodeGenFolder

Code generation folder structure – CodeGenFolderStructure

To modify the parameters during a MATLAB session, use Simulink.fileGenControl. The
parameter values that you set expire at the end of the MATLAB session.

File Generation Control Parameters
This table provides information about how you can use the parameters to manage build process
folders.

MATLAB Session
Parameter

Simulink Preference Description

CacheFolder Simulation cache
folder

The build process places generated files from
Simulink diagram updates and model build artifacts
for simulation and code generation in the simulation
cache folder simulationCacheFolder. The folder
is a root folder.

By default (CacheFolder = ''),
simulationCacheFolder is the current working
folder, pwd.

You can use the parameter to specify another folder.
For example, if you want to:

• Separate generated files from the models and
other source material.

• Reuse or share previously built simulation targets
without having to set the current working folder
back to a previous working folder.
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MATLAB Session
Parameter

Simulink Preference Description

CodeGenFolder Code generation
folder

The build process, which uses system target files to
generate production code from a Simulink model,
places the production code in the code generation
folder codeGenerationFolder. The folder is a root
folder.

If you choose to generate an executable program
file, the build process writes the file model.exe
(Windows) or model (UNIX) to the folder.

By default (CodeGenFolder = ''),
codeGenerationFolder is the current working
folder, pwd.

You can use the parameter to specify another folder.
For example, if you want to separate generated
production code from:

• Models and other source material.
• Generated simulation and code generation

artifacts.

If you specify the root folder of a drive as the code
generation folder, the build process cannot generate
code for your model. For example, C:\.

CodeGenFolderStr
ucture

Code generation
folder structure

To specify the folder structure within the code
generation folder, use the parameter. For example, if
you configure models for different target
environments, you can specify a separate subfolder
for the generated code from each model.

Build Process Folders
This table provides information about how CodeGenFolderStructure controls the folder structure
within the simulation cache folder and the code generation folder.
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Folder Name when
CodeGenFolderStructure =
'ModelSpecific'

Folder Name when
CodeGenFolderStructure =
'TargetEnvironmentSubfol
der'

Description

codeGenerationFolder/
model_target_rtw

The default for target is the
name of the selected system
target file, for example, grt,
ert, and rsim. You can change
target with the
rtwgensettings.BuildDirS
uffix field in the system
target file.

codeGenerationFolder/
targetSpecific/model

The build process uses
configuration information for
the system target file and the
hardware device to produce a
unique label for the subfolder,
targetSpecific.

Build folder, which stores
generated source code and other
files created by the build process.

Contains the generated code
modules, model.c and model.h,
and generated makefile,
model.mk.

model.mk is for compiling and
linking code generated from
model components.

model is the name of the source
model.

codeGenerationFolder/
model_target_rtw/html

codeGenerationFolder/
targetSpecific/model/
html

Code generation report folder that
contains report files generated by
the build process.

codeGenerationFolder/
slprj/target/model

codeGenerationFolder/
targetSpecific/_ref/
model

Model reference target files.

codeGenerationFolder/
slprj/target/model/
referenced_model_include
s

codeGenerationFolder/
targetSpecific/_ref/
model/
referenced_model_include
s

Header files from models
referenced by model.

codeGenerationFolder/
slprj/target/model/
tmwinternal

codeGenerationFolder/
targetSpecific/_ref/
model/tmwinternal

MAT-files used during code
generation.

codeGenerationFolder/
slprj/target/
_sharedutils

codeGenerationFolder/
targetSpecific/_shared

Utility functions for model
reference system target files,
which are shared across models.

Folder also contains
rtwshared.mk for compiling
generated shared utility code

simulationCacheFolder/
slprj/sim/model

simulationCacheFolder/
slprj/sim/model

Simulation target files for
referenced models.

simulationCacheFolder/
slprj/sim/model/
tmwinternal

simulationCacheFolder/
slprj/sim/model/
tmwinternal

MAT-files used during code
generation.

simulationCacheFolder/
slprj/sim/_sharedutils

simulationCacheFolder/
slprj/sim/_sharedutils

Utility functions for simulation
system target files, which are
shared across models.
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If the system target file is ERT-based, then these model configuration parameters also control the
location of shared utility code:

• Shared code placement (UtilityFuncGeneration)
• Existing shared code (ExistingSharedCode)

You can use RTW.getBuildDir to display build folder information for the model.

See Also
RTW.getBuildDir | Simulink.fileGenControl

More About
• “Manage Build Process Files”
• “Manage Build Process File Dependencies”
• “Add Build Process Dependencies”
• “Build Process Support for Folder Names with Spaces or Special Characters”
• “Build Process Workflow for Real-Time Systems”
• “Generate Code for Model Reference Hierarchy”
• “Cross-Release Shared Utility Code Reuse”
• “Cross-Release Code Integration”
• “Generate Code and Simulate Models in a Project”
• “Generate Code and Simulate Models Programmatically with Project”
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Manage Build Process Files
To apply generated code source and header files from the build process, it is helpful to understand
the files that the build process generates and the conditions that control file generation. This
information provides access to generated code resources, such as:

• Public interface to the model entry points
• Enumerated types corresponding to built-in data types
• Data structures that describe the model signals, states, and parameters

The code generator creates model.* files during the code generation and build process. You can
customize the file names for generated header, source, and data files. For more information, see
“Customize Generated File Names” on page 53-56. The code generator creates additional folders
and dependency files to support shared utilities and model references. For more information about
the folders that the build process creates, see “Manage Build Process Folders”. For an example that
shows how to use a project to manage build process folders, see “Generate Code and Simulate
Models in a Project”.

Depending on model architectures and code generation options, the build process for a GRT-based
system target file can produce files that the build process does not generate for an ERT-based system
target file. Also, for ERT-based system target files, the build process packages generated files
differently than for GRT-based system target files. See “Manage File Packaging of Generated Code
Modules” on page 51-12.

Note By default, the build process deletes foreign (not generated) source files in the build folder. It is
possible to preserve foreign source files in the build folder by following the guidelines in “Preserve
External Code Files in Build Folder”.

The table describes the principal generated files. Within the generated file names shown in the table,
the model represents the name of the model for which you are generating code. The subsystem
represents the name of a subsystem within the model. When you select the Create code generation
report parameter, the code generator produces a set of HTML files. There is one HTML file for each
source file plus a model_contents.html index file in the html subfolder within your build folder.
The source and header files in the table have dependency relationships. For descriptions of other file
dependencies, see “Manage Build Process File Dependencies” and “Add Build Process
Dependencies”.

File Description
builtin_typeid_types.h Defines an enumerated type corresponding to built-in data types.

A model build generates this file when one or more of these conditions apply:

• Your model contains a Stateflow chart that uses messages.
• Your model configuration enables MAT-file logging.
• Your model configuration enables C API options in Code Generation >

Interface.
modelsources.txt Lists additional sources to include in the compilation.
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File Description
model.bat Contains Windows batch file commands that set the compiler environment

and invoke the make utility.

For more information about using this file, see “model.bat” on page 50-38.
model.c

model.cpp

Corresponds to the model file.

The Target Language Compiler generates this C or C++ source code file. The
file contains:

• Include files model.h and model_private.h
• Data, except data placed in model_data.c
• Model-specific scheduler code
• Model-specific solver code
• Model registration code
• Algorithm code
• Optional GRT wrapper functions

model.exe (Windows platform)

model (UNIX and Macintosh
platforms)

Executable program file.

A model build generates this file unless you explicitly specify that the code
generator produce code only. The build generates the executable in the
current folder (not the build folder) under control of the make utility of your
development system.

model.h Defines model data structures and a public interface to the model entry
points and data structures. Provides an interface to the real-time model data
structure (model_rtM) via access macros.

Subsystem .c or .cpp files in the model include model.h. This file includes:

• Exported Simulink data symbols
• Exported Stateflow machine parented data
• Model data structures, including rtM
• Model entry-point functions

For more information, see “model.h”.
model.mk Generated makefile that controls compiling and linking the generated code

into the final binary file by the make utility of your development system.

If you set the MAKEFLAGS environment variable, do not select options with
this variable that conflict with the current make utility used by the build
process.

model.rtw Represents the compiled model.

By default, the build process deletes this ASCII file when the build process is
complete. You can choose to retain the file for inspection.
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File Description
model_capi.h

model_capi.c

(optional files) Contain data structures that describe the model signals,
states, and parameters without using external mode.

For more information, see “Exchange Data Between Generated and External
Code Using C API”.

model_data.c Contains (if conditionally generated) declarations for the parameters data
structure and the constant block I/O data structure, and zero representations
for structure data types that the model uses.

A model build generates this file when the model uses these data structures.
The extern declarations for structures appear in model.h. When present,
this file contains:

• Constant block I/O parameters
• Include files model.h and model_private.h
• Definitions for the zero representations for user-defined structure data

types that the model uses
• Constant parameters

model_dt.h (optional file) Declares structures that contain data type and data type
transition information for generated model data structures for supporting
external mode.

model_private.h Contains local define constants and local data for the model and
subsystems.

The generated source files from the model build include this file. When you
interface external code with generated code from a model, include
model_private.h. The file contains:

• Imported Simulink data symbols
• Imported Stateflow machine parented data
• Stateflow entry points
• Simulink Coder details (various macros, enums, and so forth, that are

private to the code)

For more information, see “Manage Build Process File Dependencies”.
model_reference_types.h Contains type definitions for timing bridges.

A model build generates this file for a referenced model or a model
containing model reference blocks.

model_targ_data_map.m (optional file) Contains MATLAB language commands that external mode
uses to initialize the external mode connection.

model_types.h Provides forward declarations for the real-time model data structure and the
parameters data structure.

The generated header files from the model build include this file. Function
declarations of reusable functions can use these structures.
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File Description
multiword_types.h Contains type definitions for multiple-word wide data types and their word-

size chunks. If your code uses multiword data types, include this header file.

A model build generates this file when one or more of these conditions apply:

• Your model uses multiword data types.
• Your model configuration enables MAT-file logging.
• Your model configuration enables Code Generation > Interface >

External mode.
rtGetInf.c

rtGetInf.h

rtGetNaN.c

rtGetNaN.h

rt_nonfinite.c

rt_nonfinite.h

Declares and initializes global nonfinite values for inf, minus inf, and nan.
Provides nonfinite comparison functions.

A model build generates these files when one or more of these conditions
apply:

• The model contains S-functions.
• The generated code from the model requires nonfinite numbers.
• Your model configuration enables MAT-file logging.
• Your model configuration selects grt.tlc as the System target file and

enables the Classic call interface.
rtmodel.h Contains #include directives required by static main program modules such

as rt_main.c.

The build process does not create these modules at code generation time.
The modules include rtmodel.h to access model-specific data structures
and entry points. If you create your own main program module, make sure to
include rtmodel.h.

rtwtypes.h Provides the essential type definitions, #define statements, and
enumerations.

For ERT-based system target files that do not generate a GRT interface and
do not have noninlined S-functions, rtwtypes.h does not include
simstruc_types.h.

For more information, see “rtwtypes.h” and “Manage Build Process File
Dependencies”.

rtw_proj.tmw

sl_proj.tmw

Marker files.

The build process generates these files to help the make utility determine
when to recompile and link the generated code.

rt_defines.h Contains type definitions for special mathematical constants (such as π and
e) and defines the UNUSED_PARAMETER macro.

A model build generates this file when the generated code requires a
mathematical constant definition or when the function body does not access a
required model function argument.
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File Description
rt_sfcn_helper.h

rt_sfcn_helper.c

(optional files) Provide functions that the noninlined S-functions use in a
model.

The noninlined S-functions use functions rt_CallSys, rt_enableSys, and
rt_DisableSys to call downstream function-call subsystems.

subsystem.c (optional file) Contains C source code for each noninlined nonvirtual
subsystem or copy the code when the subsystem is configured to place code
in a separate file.

subsystem.h (optional file) Contains exported symbols for noninlined nonvirtual
subsystems.

model.bat
This file contains Windows batch file commands that set the compiler environment and invoke the
make utility.

If you are using the toolchain approach for the build process, you also can use this batch file to
extract information from the generated makefile, model.mk. The information includes macro
definitions and values that appear in the makefile, such as CFLAGS (C compiler flags) and CPP_FLAGS
(C++ compiler flags). With the folder containing model.bat selected as the current working folder,
in the Command Window, type:

>> system('model.bat info')

On UNIX and Macintosh platforms, the code generator does not create the model.bat file. To
extract information for toolchain approach builds from the generated makefile on these systems, in
the Command Window, type:

>> system('gmake -f model.mk info')

model.h
The header file model.h declares model data structures and a public interface to the model entry
points and data structures. This header file also provides an interface to the real-time model data
structure (model_M) by using access macros. If your code interfaces to model functions or model data
structures, include model.h:

• Exported global signals

extern int32_T INPUT;    /* '<Root>/In' */

• Global structure definitions

/* Block parameters (auto storage) */
extern Parameters_mymodel mymodel_P;

• Real-time model (RTM) macro definitions

#ifndef rtmGetSampleTime
# define rtmGetSampleTime(rtm, idx) 
((rtm)->Timing.sampleTimes[idx])
#endif
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• Model entry point functions (ERT example)

extern void mymodel_initialize(void);
extern void mymodel_step(void);
extern void mymodel_terminate(void);

The main.c (or .cpp) file includes model.h. If the model build generates the main.c (or .cpp) file
from a TLC script, the TLC source can include model.h.

#include "%<CompiledModel.Name>.h"

If main.c is a static source file, you can use the fixed header file name rtmodel.h. This file includes
the model.h header file:

#include "model.h"     /* If main.c is generated */

or

#include "rtmodel.h"   /* If static main.c is used */

Other external source files can require to include model.h to interface to model data, for example
exported global parameters or signals. The model.h file itself can have additional header
dependencies due to requirements of generated code. See “System Header Files” and “Code
Generator Header Files”.

To reduce dependencies and reduce the number of included header files, see “Manage Build Process
File Dependencies”.

rtwtypes.h
The header file rtwtypes.h defines data types, structures, and macros required by the generated
code. You include rtwtypes.h for GRT and ERT system target files, instead of including
tmwtypes.h.

Often, the generated code requires that integer operations overflow or underflow at specific values.
For example, when the code expects a 16-bit integer, the code does not accept an 8-bit or a 32-bit
integer type. The C language does not set a standard for the number of bits in types such as char,
int, and others. So, there is no universally accepted data type in C to use for sized-integers.

To accommodate this feature of the C language, the generated code uses sized integer types, such as
int8_T, uint32_T, and others, which are not standard C types. In rtwtypes.h, the generated code
maps these sized-integer types to the corresponding C keyword base type using information in the
Hardware Implementation pane of the configuration parameters.

The code generator produces the optimized version of rtwtypes.h for ERT-based system target files
when these conditions apply:

• Configuration Parameters > Code Generation > Interface > Advanced parameters >
Classic call interface is not selected.

• The model does not contain noninlined S-functions.

Include rtwtypes.h. If you include it for GRT system target files, for example, it is easier to use your
code with ERT-based system target files.

For GRT and ERT system target files, the location of rtwtypes.h depends on whether the build
process uses the shared utilities location. If it uses a shared location, the code generator places

 Manage Build Process Files

50-39



rtwtypes.h in slprj/target/_sharedutils; otherwise, it places rtwtypes.h in the build folder
(model_target_rtw). See “Specify Generated Code Interfaces”.

Source files include the rtwtypes.h header file when the source files use code generator type
names or other code generator definitions. A typical example is for files that declare variables by
using a code generator data type, for example, uint32_T myvar.

A source file that the code generator and an S-function use can use the preprocessor macro
MATLAB_MEX_FILE. The macro definition comes from the mex function:
#ifdef  MATLAB_MEX_FILE
#include "tmwtypes.h"
#else
#include "rtwtypes.h"
#endif

A source file for the code generator main.c (or .cpp) file includes rtwtypes.h without
preprocessor checks.
#include "rtwtypes.h"

Custom source files that the Target Language Compiler generates can also emit these include
statements into their generated file.

See “Control Placement of rtwtypes.h for Shared Utility Code”.

See Also

More About
• “Manage Build Process Folders”
• “Manage Build Process File Dependencies”
• “Add Build Process Dependencies”
• “Build Process Support for Folder Names with Spaces or Special Characters”
• “Build Process Workflow for Real-Time Systems”
• “Generate Code and Simulate Models in a Project”
• “Generate Code and Simulate Models Programmatically with Project”
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Manage Build Process File Dependencies
An important control of the size of generated code is managing the number and size of included files
(dependencies). To reduce the number of system header files and generated header files that
generated code requires, it is helpful to understand the dependencies that the build process
generates and the conditions that lead to dependencies.

The dependency relationships among generated source and header files appear in the figure. Arrows
coming from a file point to files it includes. Other dependencies exist, for example, on Simulink
header files tmwtypes.h and simstruc_types.h, plus C or C++ library files. The figure maps
inclusion relations between only those files that are generated in the build folder. These files can
reference utility and model reference code located in a code generation folder. For more information
about the folders and files that the build process creates, see “Manage Build Process Folders” and
“Manage Build Process Files”.

The two tables identify the conditions that control creation of dependency files for GRT and ERT
targets. To manage build-related dependencies, consider how these conditions apply to your model
and code generation process. Then, configure model parameters and code generation options to
manage build process file dependencies.

Due to differences in file packaging options for code generated with ERT-based system target files,
the file dependencies differ slightly from file packaging for code generated with GRT-based system
target files. See “Manage File Packaging of Generated Code Modules” on page 51-12.

The parent system header files (model.h) include child subsystem header files (subsystem.h). In
more layered models, subsystems similarly include their children's header files in the model
hierarchy. As a consequence, subsystems are able to view recursively into their descendant
subsystems and view into the root system because every subsystem.c or subsystem.cpp includes
model.h and model_private.h.

In the figure, files model.h, model_private.h, and subsystem.h depend on the header file
rtwtypes.h. If you use system target files that are not based on the ERT system target file, the
source files that you generate can have additional dependencies on tmwtypes.h and
simstruc_types.h.
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System Header Files
The system header files make function declarations, type definitions, and macro definitions available
to the legacy or external code. Some code generation scenarios require including header files that are
specific to the code generator product.

The code generator includes some system header files for broadly defined cases. For example,
generated code includes <stddef.h> when the model contains a utility function that requires this
header file. This approach helps identify header file dependencies:

1 Set model configuration parameter Shared code placement to 'Shared location' and build
the model. The code generator places the utility functions in __sharedutils folder.

2 Use a find-in-file utility (for example, grep utility) to search the .c and .h files in the
__sharedutils folder for #include. The search results list the utilities with header file
dependencies.

3 Use this information to identify utilities to remove from the model and reduce header file
dependencies in the generated code.

For more information, see “Generate Shared Utility Code for Fixed-Point Functions”.
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System Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

<math.h> Defines math constants

GRT—Generated code does not include this file.

ERT—Generated code includes this file when the code honors your model
configuration for solver Stop time and either:

• Your model configuration enables parameter MAT-file logging. See
“MAT-file logging”.

• Your model configuration enables parameter External mode.
<float.h> Provides floating-point math functions

GRT—Generated code includes this file when your model contains a floating-
point math function.

ERT—Generated code includes this file when your model contains a floating-
point math function, unless a code replacement library entry overrides the
function. For more information, see “Choose a Code Replacement Library”.

<stddef.h> Defines NULL

GRT and ERT—Generated code includes this file when your model contains a
utility function that requires this file.

<stdio.h> Provides file I/O functions

GRT—Generated code includes this file when your model includes a To File
block.

ERT—Generated code includes this file when either:

• Your model includes a To File block.
• Your model configuration enables parameter MAT-file logging. See
“MAT-file logging”.

<stdlib.h> Provides utility functions such as the integer versions of div() and abs()

GRT—Generated code includes this file when either:

• Your model includes a Stateflow chart.
• Your model includes a math function block configured for mod() or

rem(), which generate calls to div().

ERT—Generated code includes this file when either:

• Your model includes a Stateflow chart, and you select model configuration
parameter Support: floating-point numbers.

• Your model includes a math function block configured for mod() or
rem(), which generate calls to div().
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System Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

<string.h> Provides memory functions such as memset() and memcpy()

GRT—Generated code includes this file when your model initialization code
calls memset().

ERT—Generated code includes this file when a block or model initialization
code calls memcpy() or memset().

For a list of relevant blocks, in the Command Window, type:

showblockdatatypetable

Look for blocks with the N2 note. To omit calls to memset() from model
initialization code, select model configuration parameters Remove root
level I/O zero initialization and Remove internal data zero
initialization.

Code Generator Header Files
Dependencies in the table for generated header files apply to the system target files grt.tlc and
ert.tlc. System target files derived from these base system target files can have additional header
dependencies. Code generation for blocks from blocksets, embedded targets, and custom S-functions
can introduce additional header dependencies.

Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

builtin_typeid_types.h Defines an enumerated type corresponding to built-in data types

GRT and ERT—Generated code includes this file when one or more of these
conditions apply:

• Your model contains a Stateflow chart that uses messages.
• Your model configuration enables: MAT-file logging. See “MAT-file

logging”.
• Your model configuration selects C API options at Code Generation >

Interface.
dt_info.h Defines data structures for external mode

GRT and ERT—Generated code includes this file when your model
configuration enables external mode.

ext_work.h Defines external mode functions

GRT and ERT—Generated code includes this file when your model
configuration enables external mode.
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Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

fixedpoint.h Provides fixed-point support for noninlined S-functions

GRT—Generated code includes this file.

ERT—Generated code includes this file when either:

• Your model uses noninlined S-functions.
• Your model configuration selects parameter Classic call interface.

model_reference_types.h Contains type definitions for timing bridges

GRT and ERT—Generated code includes this file when building a reference
model or building a model that contains model blocks.

model_types.h Defines model-specific data types

GRT and ERT—Generated code includes this file.
multiword_types.h Contains type definitions for multiword-wide data types and their word-size

chunks

GRT and ERT—Generated code includes this file when one or more of these
conditions apply:

• Your model uses multiword data types.
• Your model configuration selects parameter MAT-file logging. See “MAT-
file logging”.

• Your model configuration selects External mode.

For a model that uses multiword data types, the code generator overwrites
the file if the data types are greater in length than those of the model for
which code was last generated. To avoid overwriting this file, set:

• MultiwordTypeDef to 'User defined'
• MultiwordLength to the biggest length that is required by your models.

 Manage Build Process File Dependencies

50-45



Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

rtGetInf.h

rtGetNaN.h

rt_nonfinite.h

Support nonfinite numbers

GRT—Generated code includes this file when one or more of these conditions
apply:

• Your model contains S-functions.
• The generated code requires nonfinite numbers.
• Your model configuration selects parameter MAT-file logging. See “MAT-
file logging”.

• Your model configuration selects parameter Classic call interface.

ERT—Generated code includes this file when one or more of these conditions
apply:

• Your model contains S-functions.
• The generated code requires nonfinite numbers.
• Your model configuration selects parameter MAT-file logging. See “MAT-
file logging”.

rt_defines.h Contains type definitions for special mathematical constants (such as π and
e) and defines the UNUSED_PARAMETER macro

GRT and ERT—Generated code includes this file when either:

• The generated code requires a mathematical constant definition.
• The function body does not access a required model function argument.

rt_logging.h Supports MAT-file logging and includes:

rtwtypes.h
builtin_typeid_types.h
multiword_types.h
rt_mxclassid.h
rtw_matlogging.h

GRT—Generated code includes this file.

ERT—Generated code includes this file when you model configuration selects
parameter MAT-file logging. See “MAT-file logging”.

rt_mxclassid.h Defines mxArray class ID enumerations

GRT and ERT—Generated code includes this file when the code includes
rt_logging.c.
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Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

rtw_continuous.h Supports continuous time

GRT—Generated code includes this file when the code includes
simstruc_types.h.

ERT—Generated code includes this file when your model configuration
selects parameter Support: continuous time and when the code does not
already include simstruc.h.

rtw_extmode.h Supports external mode

GRT—Generated code includes this file when the code includes
simstruc_types.h.

ERT—Generated code includes this file when your model configuration
selects external mode and when the code does not already include
simstruc.h.

rtw_matlogging.h Supports MAT-file logging

GRT—Generated code includes this file when the code includes
simstruc_types.h and rt_logging.h.

ERT—Generated code includes this file when the code includes
rt_logging.h.

rtw_solver.h Supports continuous states

GRT—Generated code includes this file when the code includes
simstruc_types.h.

ERT—Generated code includes this file when your model configuration
selects parameter Support: continuous time and when the code does not
already include simstruc.h.
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Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

rtwtypes.h Defines code generator data types

GRT—Generated code includes this file. Uses a verbose version of the file,
which includes tmwtypes.h.

ERT—Generated code includes this file. See “rtwtypes.h” on page 50-39.

The code generator overwrites the previously generated rtwtypes.h when you
enable (previously disabled) support for:

• Complex numbers (SupportComplex set to 'on').
• Noninlined S-functions (SupportNonInlinedSFcns set to 'on')

To avoid rewriting rtwtypes.h, you can:

• Specify support for complex datatypes for your models even if the models
do not currently use complex data types.

• Disable support for noninlined S-functions. In this case, the use of a
noninlined S-function produces an error. To avoid the error, convert the S-
function to an inlined S-function. For more information, see “Inlining S-
Functions” on page 15-8.

simstruc.h Supports calling noninlined S-functions that use the Simstruct definition;
also includes:

limits.h
string.h
tmwtypes.h
simstruc_types.h

GRT—Generated code includes this file.

ERT—Generated code includes this file when either:

• Your model uses noninlined S-functions.
• Your model configuration selects parameter Classic call interface.

simstruc_types.h Provides definitions that the generated code uses and includes the header
files:

rtw_matlogging.h
rtw_extmode.h
rtw_continuous.h
rtw_solver.h
sysran_types.h

GRT—Generated code includes this file when the code includes rtwtypes.h.

ERT—Generated code does not include this file. For ERT, rtwtypes.h
contains definitions, and model.h contains header files.

50 Source Code Generation in Simulink Coder

50-48



Header File Description and Inclusion Conditions for GRT or ERT System Target
Files

sysran_types.h Supports external mode

GRT—Generated code includes this file when the code includes
simstruc_types.h.

ERT—Generated code includes this file when your model configuration
selects external mode and when the code does not already include
simstruc.h.

zero_crossing_types.h Contains zero-crossing definitions for models with triggered subsystems
where the trigger is rising, falling, or either. File is generated only if required
by the model as determined by the data type of the trigger signal. For
example, if the data type of the trigger signal is Boolean, zero-crossing
detection is not needed.

GRT—Generated code does not include this file for GRT code generation
targets.

ERT—Generated code includes this file when a model has a conditionally
executed subsystem where a trigger uses zero crossing detection.

If generated, the content of zero_crossing_types.h is always the same.

See Also

More About
• “Manage Build Process Folders”
• “Manage Build Process Files”
• “Add Build Process Dependencies”
• “Build Process Support for Folder Names with Spaces or Special Characters”
• “Build Process Workflow for Real-Time Systems”
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Add Build Process Dependencies
When you specify a system target file for code generation, the code generator can build a standalone
executable program that can run on the development computer. To build the executable program, the
code generator uses the selected compiler and the makefile generated by the toolchain or template
makefile (TMF) build process approach. Part of the makefile generation process is to add source file,
header file, and library file information (the dependencies) in the generated makefile for a
compilation. Or, for a specific application, you can add the generated files and file dependencies
through a configuration management system.

The generated code for a model consists of a small set of files. (See “Manage Build Process Files”.)
These files have dependencies on other files, which occur due to:

• Header file inclusions
• Macro declarations
• Function calls
• Variable declarations

The model or external code introduces dependencies for various reasons:

• Blocks in a model generate code that makes function calls. These calls can occur in several forms:

• Included source files (not generated) declare the called functions. In cases such as a blockset,
manage these source file dependencies by compiling them into a library file.

• The generated code makes calls to functions in the run-time library provided by the compiler.
• Some function dependencies also are generated files, which are referred to as shared utilities.

Some examples are fixed-point utilities and non-finite support functions. These dependencies
are referred to as shared utilities. The generated functions can appear in files in the build
folder for standalone models or in the _sharedutils folder under the slprj folder for builds
that involve model reference.

• Models with continuous time require solver source code files.
• Code generator options such as external mode, C API, and MAT-file logging.
• External code specifies dependencies.

File Dependency Information for the Build Process
The code generator provides several mechanisms to input file dependency information into the build
process. The mechanisms depend on whether your dependencies are block-based or are model- or
system target file-based.

For block dependencies, consider using:

• S-functions and blocksets

• Add folders that contain S-function MEX-files that the model uses to the header include path.
• Create makefile rules for these folders to allow for finding source code.
• Specify additional source file names with the S-Function block parameter

SFunctionModules.
• Specify additional dependencies with the rtwmakecfg.m mechanism. See “Use rtwmakecfg.m

API to Customize Generated Makefiles”.
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For more information on applying these approaches to legacy or external code integration, see
“Import Calls to External Code into Generated Code with Legacy Code Tool”.

• S-Function Builder block, which provides its own UI for specifying dependency information

For model- or system target file-based dependencies, such as external header files, consider using:

• The Code Generation > Custom Code pane in the Configuration Parameters dialog box. You can
specify additional libraries, source files, and include folders.

• TLC functions LibAddToCommonIncludes() and LibAddToModelSources(). You can specify
dependencies during the TLC phase. See “LibAddToCommonIncludes(incFileName)” and
“LibAddSourceFileCustomSection(file, builtInSection, newSection)”. The Embedded Coder
product also provides a TLC-based customization template for generating additional source files.

Generated Makefile Dependencies

For toolchain approach or template makefile (TMF) approach build processes, the code generator
generates a makefile. For TMFs, the generated makefile provides token expansion in which the build
process expands different tokens in the makefile to include the additional dependency information.
The resulting makefile contains the complete dependency information. See “Customize Template
Makefiles”.

The generated makefile contains:

• Names of the source file dependencies
• Folders where source files are located
• Location of the header files
• Precompiled library dependencies
• Libraries that the make utility compiles and creates

A property of make utilities is that you do not have to specify the specific location for a given source C
or C++ file. If a rule exists for that folder and the source file name is a prerequisite in the makefile,
the make utility can find the source file and compile it. The C or C++ compiler (preprocessor) does
not require absolute paths to the headers. The compiler finds header file with the name of the header
file by using an #include directive and an include path. The generated C or C++ source code
depends on this standard compiler capability.

Libraries are created and linked against, but occlude the specific functions that the program calls.

These properties can make it difficult to determine the minimum list of file dependencies manually.
You can use the makefile as a starting point to determine the dependencies in the generated code.

Another approach to determining the dependencies is using linker information, such as a linker map
file, to determine the symbol dependencies. The map file provides the location of code generator and
blockset source and header files to help in locating the dependencies.

Code Generator Static File Dependencies

Several locations in the MATLAB folder tree contain static file dependencies specific to the code
generator:

• matlabroot/rtw/c/src (open)

This folder has subfolders and contains additional files must be compiled. Examples include solver
functions (for continuous time support), external mode support files, C API support files, and S-
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function support files. Include source files in this folder into the build process with the SRC
variables of the makefile.

• Header files in the folder matlabroot/rtw/extern/include
• Header files in the folder matlabroot/simulink/include

These folders contain additional header file dependencies such as tmwtypes.h,
simstruc_types.h, and simstruc.h.

Note For ERT-based system target files, you can avoid several header dependencies. ERT-based
system target files generate the minimum set of type definitions, macros, and so on, in the file
rtwtypes.h.

Blockset Static File Dependencies

Blockset products with S-function code apply the rtwmakecfg.m mechanism to provide the code
generator with dependency information. The rtwmakecfg.m file from the blockset contains the list of
include path and source path dependencies for the blockset. Typically, blocksets create a library from
the source files to which the generated model code can link. The libraries are created and identified
when you use the rtwmakecfg.m mechanism.

To locate the rtwmakecfg.m files for blocksets in your MATLAB installed tree, use the following
command:

>> which -all rtwmakecfg.m

If the model that you are compiling uses one or more of the blocksets listed by the which command,
you can determine folder and file dependency information from the respective rtwmakecfg.m file.

Folder Dependency Information for the Build Process
You can add #include statements to generated code. Such references can come from several
sources, including TLC scripts for inlining S-functions, custom storage classes, bus objects, and data
type objects. The included files consist of header files for external code or other customizations. You
can specify compiler include paths with the -I compiler option. The build process uses the specified
paths to search for included header files.

Usage scenarios for the generated code include, but are not limited to, the following:

• A custom build process compiles generated code that requires an environment-specific set of
#include statements.

In this scenario, the build process invokes the code generator when you select model
configuration parameter Generate code only. Consider using fully qualified paths, relative paths,
or just the header file names in the #include statements. Use include paths.

• The build process compiles the generated code.

In this case, you can specify compiler include paths (-I) for the build process in several ways:

• Specify additional include paths on the Code Generation > Custom Code pane in the
Configuration Parameters dialog box. The code generator propagates the include paths into the
generated makefile.

50 Source Code Generation in Simulink Coder

50-52



• The rtwmakecfg.m mechanism allows S-functions to introduce additional include paths into
the build process. The code generator propagates the include paths into the generated
makefile.

• When building a model that uses a custom system target file and is makefile-based, you can
directly add the include paths into the template makefile that the system target file uses.

• Use the make command to specify a USER_INCLUDES make variable that defines a folder in
which the build process searches for included files. For example:

make_rtw USER_INCLUDES=-Id:\work\feature1

The build process passes the custom includes to the command-line invocation of the make
utility, which adds them to the overall flags passed to the compiler.

Use #include Statements and Include Paths

Consider the following approaches for using #include statements and include paths with the build
process to generate code that remains portable and minimizes compatibility problems with future
versions.

Assume that additional header files are:
c:\work\feature1\foo.h
c:\work\feature2\bar.h

• An approach is to include in the #include statements only the file name, such as:
#include "foo.h"
#include "bar.h"

Then, the include path passed to the compiler contains folders in which the headers files exist:
cc -Ic:\work\feature1 -Ic:\work\feature2     ...

• Another approach is to use relative paths in #include statements and provide an anchor folder
for these relative paths using an include path, for example:
#include "feature1\foo.h"
#include "feature2\bar.h"

Then, specify the anchor folder (for example \work) to the compiler:
 cc -Ic:\work   ...

Avoid These Folder Dependencies

When using the build process, avoid dependencies on folders in the build process “Code generation
folder”, such as the model_ert_rtw folder or the slprj folder. Do not use paths in #include
statements that are relative to the location of the generated source file. For example, if your MATLAB
code generation folder is c:\work, the build process generates the model.c source file into a
subfolder such as:
c:\work\model_ert_rtw\model.c

The model.c file has #include statements of the form:
#include "..\feature1\foo.h"
#include "..\feature2\bar.h"

It is preferable to use one of the other suggested approaches because the relative path creates a
dependency on the code generator folder structure.
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See Also

More About
• “Manage Build Process Folders”
• “Manage Build Process Files”
• “Manage Build Process File Dependencies”
• “Build Process Support for Folder Names with Spaces or Special Characters”
• “Build Process Workflow for Real-Time Systems”
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Build Process Support for Folder Names with Spaces or Special
Characters

Folder Names with Spaces
On a Windows system, the code generator maps a drive corresponding to the MATLAB installation
folder for either of these conditions:

• The matlabroot folder is a UNC location.
• The path the matlabroot folder contains spaces, and the system has no alternative name

support.

These folder paths can contain spaces:

• The path to your MATLAB installation folder (matlabroot). For example, C:\Program Files
\MATLAB\R2015b

• The path to the current working folder where you start the build (pwd). For example, C:\Users
\username\Documents\My Work.

• The path to the installation folder for a compiler that the build process uses.

If your work environment includes one or more of the preceding scenarios, use the following support
mechanisms for the build process:

• If you are using the toolchain approach to build generated code, the system support for spaces in
folder names influences toolchain operation:

• For Linux® systems and Windows systems with 8.3 name creation enabled, the toolchain
manages spaces in folder names by using alternative names from the operating system. The
toolchain uses the TransformPathsWithSpaces attribute to manage these names.

addAttribute(toolchainObject, 'TransformPathsWithSpaces', true);

The security permissions of drives and folders can determine whether the toolchain transforms
the path. For example, if the path contains a folder with a security configuration that forbids
8.3 path transformations, the toolchain does not transform the path and the build process
produces a warning.

• For Windows systems with 8.3 name creation disabled, the toolchain manages spaces in folder
names by mapping a network drive using a batch file (.bat). This operation requires adding the
RequiresBatchFile attribute to the toolchain definition.

addAttribute(toolchainObject, 'RequiresBatchFile', true);

When developing a toolchain for a Windows system, set both attributes. For more information
about the toolchain attributes, see addAttribute.

• If you are using the template makefile approach to build generated code, the template makefile
(.tmf) requires code to manage spaces in folder names. When the alternative folder names
(Windows short names) differ from the file system folder names (Windows long names), add this
code to the makefile.
ALT_MATLAB_ROOT         = |>ALT_MATLAB_ROOT<|
ALT_MATLAB_BIN          = |>ALT_MATLAB_BIN<|
!if "$(MATLAB_ROOT)" != "$(ALT_MATLAB_ROOT)"
MATLAB_ROOT = $(ALT_MATLAB_ROOT)
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!endif
!if "$(MATLAB_BIN)" != "$(ALT_MATLAB_BIN)"
MATLAB_BIN = $(ALT_MATLAB_BIN)
!endif

When the values of the location tokens are not equal, this code replaces MATLAB_ROOT with
ALT_MATLAB_ROOT. The replacement indicates that the path to your MATLAB installation folder
includes spaces. This code applies the same type of replacement for MATLAB_BIN with
ALT_MATLAB_BIN. The preceding code is specific to nmake. For platform-specific examples, see
the supplied template makefiles.

With either build approach, when there is an issue with support for creation of alternate names (short
names), build errors can occur on Windows. If a build generates an error message similar to the
following message, see “Troubleshooting Errors When Folder Names Have Spaces” on page 50-57.

NMAKE : fatal error U1073: don't know how to make ' ...

When using operating system commands, such as system or dos, enclose paths that specify
executable files or command parameters in double quotes (" "). For example:
system('dir "D:\Applications\Common Files"')

This table provides a summary of build folder support and limitations for Windows.

Build Process
Folders

Approach for Paths with UNC or
Spaces

Support for Windows

matlabroot
folder

The matlabroot
value is derived
from the MATLAB
installation
location.

During a build, a UNC location such as:
\\networkdrive\matlab\R20xxb

could be remapped as:
T:\

During a build on a Windows system
with short file name (8.3) support
(default for Windows using NTFS), the
build process uses the Windows API
getShortPathName() for the folder
location.

During a build on a Windows system
without short file name (8.3) support
(systems using ReFS or using NTFS
with 8.3 support disabled), a location
with spaces in the path such as:
C:\Program Files\MATLAB\R20xxb

could be remapped as:
T:\R20xxb

Build process folder support available
independent of file system (NTFS or
ReFS) or file system configuration for
short file name support.

Limitations:

On systems that require drive mapping
for the installation location, the build
process requires that a drive letter is
available for mapping.

On systems without short file name
(8.3) support (using ReFS or using
NTFS with 8.3 support disabled), the
final folder in the installation location
cannot contain spaces. For example, a
final folder name:
C:\Program Files\MATLAB\R20xxb sp1

is not supported.

Code generation
folder

Simulation cache
folder

For UNC locations, build process
temporarily maps a drive by using the
shell commands pushd and popd.

Build process folder support is
available independent of file system
(NTFS or ReFS) or file system
configuration for short path name
support.
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Build Process
Folders

Approach for Paths with UNC or
Spaces

Support for Windows

Custom code
source file
locations—among
others, these
locations include
folders specified
by:

• rtwmakecfg.m
• Model
configuration
parameter
Additional
build
information

• Code
replacement
library

For paths with spaces, build process
uses the Windows short path name
(8.3) by using the Windows API:
getShortPathName()

Build process folder support depends
on NTFS file system and requires
Windows default support. Registry sets
value of 2 or 0 for:
NtfsDisable8dot3NameCreation

Limitations: Build process does not
support spaces in the path to these
folders for:

• NTFS file system with short path
name support disabled

• ReFS file system (this file system
does not support short path names)

Folder Names with Special Characters
If a build-related folder path contains a Japanese (multibyte) character where the final byte is equal
to the 5C hexadecimal character, the build process might produce an error. The make and compiler
tools might incorrectly interpret the final byte as the '\' (backslash) character.

Troubleshooting Errors When Folder Names Have Spaces
On Windows, when there is an issue with support for creation of short file names, build process
errors can occur. When this issue affects a build, you see an error message similar to:
NMAKE : fatal error U1073: don't know how to make 'C:\Work\My'

This message can occur if a space in the folder name (C:\Work\My Models) prevents the build
process from finding the model or a file to build. For descriptions of the build-related folders that are
sensitive to a space in the folder name or path, see “Folder Names with Spaces” on page 50-55.

To avoid issues from folder names with spaces when Windows short file name support for file names
is disabled, do not use paths with spaces. For example, install third-party software to paths without
spaces. Do not use paths with spaces for folders containing your models, source files, or libraries.

An issue can occur with builds that use folder names with spaces, because it is possible to disable
Windows alternate name support. The build process uses this alternate name support on Windows
systems. There are many terms for this file, folder, and path alternate name support:

• 8.3 name
• DOS path
• short file name (SFN, ShortFileName)
• long name alias
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• Windows path alias

Verify the type of file system that the drive uses. In Windows Explorer, right-click the drive icon and
select properties.

• If the file system is ReFS (Resilient File System), it is an issue. The ReFS does not provide short
file name support. Except for the MATLAB installation folder, the build process does not support
folder names with spaces for the ReFS file system. If your work environment requires short file
name support for the build folder or for additional external code folders, do not use ReFS.

• If the file system is NTFS (New Technology File System), it is possible that the build error is
related to a registry setting incompatibility. Continue with troubleshooting steps.

The error could stem from an issue with short file name support on a system using NTFS. Check the
Windows registry setting that enables the creation of short names for files, folders, and paths.

1 Open the Windows command prompt, running as administrator. For example, from the Windows
Start menu, type cmd, right-click the cmd.exe icon, and select Run as administrator.

2 Change to the windows\system32 folder and query the NtfsDisable8dot3NameCreation
status by typing:
> fsutil 8dot3name query

3 If the registry state of NtfsDisable8dot3NameCreation is not 2, the default (Volume level
setting), change the value to 2 by typing:
> fsutil 8dot3name set 2

For more information about enabling creation of short names. See https://
technet.microsoft.com/en-us/library/ff621566.aspx.

Changing the registry setting enables creation of short names only for files and folders that are
created after the change.

4 To create short names for files created while short name creation was disabled, at the Windows
command line, use the fsutil utility.

To set the short name, the syntax is:
> fsutil file setshortname <FileName> <ShortName>

For example, to create the short name PROGRA~1 for the long name C:\Program Files, type:
> fsutil file setshortname "C:\Program Files" PROGRA~1

The C:\Program Files folder name is in quotations because it has spaces.  
5 To verify that the short name was created, use the dir command with /x option to show short

names.
> dir C:\ /x

See Also
addAttribute

More About
• “Manage Build Process Folders”

50 Source Code Generation in Simulink Coder

50-58

https://en.wikipedia.org/wiki/ReFS
https://en.wikipedia.org/wiki/NTFS
https://technet.microsoft.com/en-us/library/ff621566.aspx
https://technet.microsoft.com/en-us/library/ff621566.aspx


• “Manage Build Process Files”
• “Manage Build Process File Dependencies”
• “Add Build Process Dependencies”
• “Build Process Workflow for Real-Time Systems”

External Websites
• MATLAB Answers: “Why is the build process failing ...?”
• https://technet.microsoft.com/en-us/library/cc788058.aspx
• https://technet.microsoft.com/en-us/library/cc788058.aspx
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Code Generation of Matrices and Arrays
MATLAB stores matrix data and arrays (1–D, 2–D, ...) in column-major format as a vector. Simulink
and the code generator can store array data in column-major or row-major format. For an array
stored in column-major layout, the elements of the columns are contiguous in memory. In row-major
layout, the elements of the rows are contiguous. Array layout is also referred to as order, format, and
representation. The order in which elements are stored can be important for integration, usability,
and performance. Certain algorithms perform better on data stored in a particular order.

Programming languages and environments assume a single array layout for all data. MATLAB and
Fortran use column-major layout by default, whereas C and C++ use row-major layout. With Simulink
Coder, you can generate C/C++ code that uses row-major layout or column-major layout.

Array Storage in Computer Memory
Computer memory stores data in terms of one-dimensional arrays. For example, when you declare a
3-by-3 matrix, the software stores this matrix as a one-dimensional array with nine elements. By
default, MATLAB stores these elements with a column-major array layout. The elements of each
column are contiguous in memory.

Consider the matrix A:

A =
    1   2   3
    4   5   6
    7   8   9

A translates to an array of length 9 in this order:

A(1) = A(1,1) = 1; 
A(2) = A(2,1) = 4; 
A(3) = A(3,1) = 7; 
A(4) = A(1,2) = 2; 
A(5) = A(2,2) = 5;

and so on.

In column-major format, the next element of an array in memory is accessed by incrementing the first
index of the array. For example, these element pairs are stored sequentially in memory:

• A(i) and A(i+1)
• B(i,j) and B(i+1,j)
• C(i,j,k) and C(i+1,j,k)

The matrix A is represented in memory by default with this arrangement:

     1     4     7     2     5     8     3     6     9

In row-major array layout, the programming language stores row elements contiguously in memory.
In row-major layout, the elements of the array are stored as:

     1     2     3     4     5     6     7     8     9
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You can store the N-dimensional arrays in column-major or row-major layout. In column-major layout,
the elements from the first (leftmost) dimension or index are contiguous in memory. In row-major
layout, the elements from the last (rightmost) dimension or index are contiguous.

For more information on the internal representation of MATLAB data, see “MATLAB Data”.

Code generation software uses column-major format by default for several reasons:

• The world of signal and array processing is largely in column-major array layout: MATLAB,
LAPack, Fortran90, and DSP libraries.

• A column is equivalent to a channel in frame-based processing. In this case, column-major storage
is more efficient.

• A column-major array is self-consistent with its component submatrices:

• A column-major 2-D array is a simple concatenation of 1-D arrays.
• A column-major 3-D array is a simple concatenation of 2-D arrays.
• The stride is the number of memory locations to index to the next element in the same

dimension. The stride of the first dimension is one element. The stride of the nth dimension
element is the product of the sizes of the lower dimensions.

• Row-major n-D arrays have their stride of 1 for the highest dimension. Submatrix
manipulations are typically accessing a scattered data set in memory, which does not allow for
efficient indexing.

C uses row-major format. MATLAB and Simulink use column-major format by default. You can
configure the code generation software to generate code with a row-major array layout. If you are
integrating external C code with the generated code, see the considerations listed in this table.

Action Consider
Configure array layout of the model for code
generation.

In the Configuration Parameters dialog box, set
model configuration parameter Array layout to
Column-major or Row-major.

Enable efficient row-major algorithms for
simulation and code generation.

Select model configuration parameter Use
algorithms optimized for row-major array
layout.
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Action Consider
Integrate external C code functions in row-major
array layout with the generated code.

Create S-functions that integrate external code
functions with the generated code by using:

• The SimStruct function
ssSetArrayLayoutForCodeGen.

• The “Set Array Layout” setting in the S-
Function Builder block.

• The Legacy Code Tool option
convert2DMatrixToRowMajor in
legacy_code. Using
convert2DMatrixToRowMajor impacts code
efficiency.

Use the C Caller block to call external C functions
into Simulink. Specify array layout of custom C
functions by using model configuration parameter
Default function array layout.

You can also use coder.ceval in a MATLAB
Function block. See “Interface with Row-Major
Data in MATLAB Function Block”.

Code Generator Matrix Parameters
The compiled model file, model.rtw, represents matrices as character vectors in MATLAB syntax,
without an implied storage format. This format enables you to copy the character vector out of
an .rtw file, paste it into a MATLAB file, and have MATLAB recognize it.

Column-Major Layout

For example, the 3-by-3 matrix in the Constant block

    1   2   3
    4   5   6
    7   8   9

is stored in model.rtw as

Parameter {
      Identifier          "Constant_Value"
      LogicalSrc          P0
      Protected              no
      Value              [1.0, 4.0, 7.0, 2.0, 5.0, 8.0, 3.0, 6.0, 9.0]
      CGTypeIdx              18
      ContainerCGTypeIdx      19
      ReferencedBy          Matrix(1,4)
[[0, -1, 0, 0];]
      GraphicalRef          Matrix(1,2)
[[0, 1];]
      BHMPrmIdx              0
      GraphicalSource          [0, 1]
      OwnerSysIdx          [0, -1]
      VarGroupIdx          [1, 0]
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      WasAccessedAsVariable   1
    }

The model_data.c file declares the actual storage for the matrix parameter. You can see that the
format is in column-major layout.

Parameters model_P = {
  /* Expression: [ [1,2,3] ; [4,5,6] ;[7,8,9]]
   * Referenced by: '<Root>/Constant  '
   */
  { 1.0, 4.0, 7.0, 2.0, 5.0, 8.0, 3.0, 6.0, 9.0 }
};

Row-Major Layout

For example, the 3-by-3 matrix in the Constant block

    1   2   3
    4   5   6
    7   8   9

is stored in model.rtw as

Parameter {
      Identifier          "Constant_Value"
      LogicalSrc          P0
      Protected              no
      Value              [1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, 8.0, 9.0]
      CGTypeIdx              18
      ContainerCGTypeIdx      19
      ReferencedBy          Matrix(1,4)
[[0, -1, 0, 0];]
      GraphicalRef          Matrix(1,2)
[[0, 1];]
      BHMPrmIdx              0
      GraphicalSource          [0, 1]
      OwnerSysIdx          [0, -1]
      VarGroupIdx          [1, 0]
      WasAccessedAsVariable   1
    }

The model_data.h file declares the actual storage for the matrix parameter. You can see that the
format is in row-major layout.

 Code Generation of Matrices and Arrays

50-63



Parameters model_P = {
  /* Expression: [ [1,2,3] ; [4,5,6] ;[7,8,9]]
   * Referenced by: '<Root>/Constant  '
   */
  { 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, 8.0, 9.0 }
};

Internal Data Storage for Complex Number Arrays
Simulink and code generator internal data storage formatting differs from MATLAB internal data
storage formatting only in the storage of complex number arrays. In MATLAB, the real and imaginary
parts are stored in separate arrays. In Simulink and the code generator, the parts are stored in an
interleaved format. The numbers in memory alternate real, imaginary, real, imaginary, and so forth.
This convention allows efficient implementations of small signals on Simulink lines, for Mux blocks,
and other virtual signal manipulation blocks. For example, the signals do not actively copy their
inputs, just the references.

Unsupported Blocks for Row-Major Code Generation
The code generator does not support these blocks for code generation in row-major array layout.

Continuous

• Derivative
• Integrator
• Integrator Limited
• Integrator, Second-Order
• Integrator, Second-Order Limited
• PID Controller
• PID Controller (2DOF)
• State-Space
• Transfer Fcn
• Transport Delay
• Variable Time Delay
• Variable Transport Delay
• Zero-Pole

User-Defined Functions

• Interpreted MATLAB Function
• Level-2 MATLAB S-Function
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• MATLAB System

Sources

• From Spreadsheet

Signal Attributes

• IC

Limitations for Row-Major Code Generation
• Variable-size signals are not supported for row-major code generation.

See Also

More About
• “MATLAB Data”
• “Mapping MATLAB Types to Types in Generated Code”
• “Row-Major and Column-Major Array Layouts”
• “Dimension Preservation of Multidimensional Arrays” on page 33-109
• “Preserve Dimensions of Bus Elements in Generated Code” on page 45-7
• “Interface with Row-Major Data in MATLAB Function Block”
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Cross-Release Shared Utility Code Reuse
In this section...
“Workflow to Reuse Shared Utility Code” on page 50-66
“Required Editing for Shared Utility Code Reuse” on page 50-67

When you generate code for a model, the code generator by default creates shared utility files that
the model requires. When you generate code with different releases, the code generators can
produce functionally identical shared files that contain some nonfunctional differences. For example,
different comments and different coding style. When you use the same release to generate code for
different models in different folders, you can also produce shared files with nonfunctional differences.
For example, if you specify different ParenthesesLevel or ExpressionFolding values for the
models, the code generator can produce shared files that contain different comments or different
coding styles.

Integrated code that includes functionally identical shared files:

• Is more expensive to verify because each shared file requires verification.
• Produces compilation errors if the shared files define duplicate symbols.

If you have an Embedded Coder license, you can avoid these issues by specifying the reuse of shared
code from an existing folder, for example, a read-only library of verified code. In this case, the code
generator does not create new shared utility files. The build process uses external code or previously
generated shared utility code from the folder. An administrator maintains and updates the read-only
library.

Workflow to Reuse Shared Utility Code
1 In the Configuration Parameters dialog box:

a In the Existing shared code field, enter the full path to your shared code folder.
b Verify that the Use only existing shared code diagnostic is set to error (default).

2 Remove the slprj folder or move to a new working folder.
3 Build your model. If you do not see an error, your shared code folder contains the required

shared utility files.
4 If files are missing from the existing shared code folder, you see an error. To continue code

generation with a locally generated version of the missing shared utility files:

a Set the Use only existing shared code diagnostic to warning.
b Rebuild your model. The code generation process uses a locally generated version of the

missing shared utility files.
c Provide the administrator of the verified code library with your model and information about

missing shared utility files. With the model, the administrator generates the required shared
utility files. Using sharedCodeUpdate, the administrator adds the files to the existing
shared code folder.

If you require reuse of shared code for a component exported from a previous release,
provide the administrator with information about the build folder location for the component.
The administrator can use sharedCodeUpdate to copy the shared code for the component
to the existing shared code folder.
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d When the files are available in the existing shared code folder, repeat steps 1–3.

If the shared utility code is generated from library subsystems that are shared across models,
you cannot reuse the code across releases because the code is release-specific—the symbol name
and file name mangling includes the release number. The administrator must add the shared
utility code generated for each release to the shared code folder.

The sharedCodeUpdate function can add files to the shared code folder that have identical
content but different file and function names. This behavior is useful when you have different
model components that require their own shared utility functions. Although some code is
duplicated, the different model components can access the shared utility functions with which
they were verified. To force model components to have their own versions of shared utility
functions, configure naming rules to insert the model name into shared utility identifiers.

Required Editing for Shared Utility Code Reuse
For most shared utility code files, you can specify master copies that you can reuse across releases
without modifying the files. With some files, for example, rtwtypes.h, and
zero_crossing_types.h, there are situations where manual editing is required to produce master
copies that you can use with generated code from different releases. For example:

• The rtwtypes.h file generated by releases up to and including R2013a contains a checksum.

/* This ID is used to detect inclusion
   of an incompatible rtwtypes.h */
#define RTWTYPES_ID_C08S16I32L64N64F0

For each version of this rtwtypes.h file that you want to include in your integration, copy the
corresponding #define statement into your master copy of rtwtypes.h.

• In R2015a, the zero-crossing definitions moved from rtwtypes.h into
zero_crossing_types.h. To create an rtwtypes.h file that is compatible with generated
model code from different releases, in your master copy of rtwtypes.h, insert this statement.

#include "zero_crossing_types.h"

Remove definitions from rtwtypes.h that zero_crossing_types.h provides.

See Also
crossReleaseImport | sharedCodeUpdate

Related Examples
• “Cross-Release Code Integration” on page 50-68

More About
• “Generate Shared Utility Code”
• “Generate Shared Utility Code for Fixed-Point Functions”
• “Generate Shared Utility Code for Custom Data Types”
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Cross-Release Code Integration
In this section...
“Workflow” on page 50-68
“Limitations” on page 50-70
“Simulink.Bus Support” on page 50-71
“Root-Level I/O Through Global Variables in Generated Code” on page 50-72
“Communicate Between Current and Previous Release Components Through Global Data Stores” on
page 50-74
“Parameter Tuning” on page 50-75
“Use Multiple Instances of Code Generated from Reusable Referenced Model” on page 50-76
“Compare Simulation Behavior of Model Component in Current Release and Generated Code from
Previous Release” on page 50-77
“Import AUTOSAR Code from Previous Releases” on page 50-78

If you have an Embedded Coder license, you can integrate generated C code from previous releases
(R2010a and later) with generated code from the current release when the source models are single-
rate and the generated C code is from:

• Top-model or subsystem build processes that use the nonreusable function code interface.
• Single or multiple instance model reference build processes that suppress error status monitoring

(SuppressErrorStatus is on).

If you can reuse existing code without modification, you can reduce the cost of reverification.

Workflow
Consider this control system model.
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The Controller Model block references a model that consists of three components:

• P1 is a Model block, which references a model developed with a previous release, for example,
R2015b. The generated model code, with the standalone code interface, is in the folder
P1_ert_rtw.

• C1 is a Model block, which references a model that you are developing in the current release.
• P2 is a subsystem block developed with a previous release, for example, R2016a. The generated

subsystem code is in the folder P2_ert_rtw.
• P3 is a Model block, which references a model developed with a previous release, for example,

R2016b. The generated model code, with the model reference code interface, is in the folder
slprj/ert/P3.

To integrate code from previous releases with generated code from the current release, use this
workflow:

1 Specify an existing shared code folder

You can specify the reuse of shared code from an existing folder, for example, a library of verified
code that an administrator maintains and updates. Specify the shared code folder for model
components that require code generation in the current release, for example, Controller and
C1.
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In the Configuration Parameters dialog box, in the Existing shared code field, enter the full
path to the shared code folder.

2 Import components into current release

From the current release, import generated component code from previous releases as software-
in-the-loop (SIL) blocks or processor-in-the-loop (PIL) blocks. For example:
crossReleaseImport(folderPathForP1_ert_rtw,'Controller', ...
'SimulationMode','SIL');
crossReleaseImport(folderPathForP2_ert_rtw,'Controller', ...
'SimulationMode','SIL');
crossReleaseImport(folderPathForP3,'Controller', ...
'SimulationMode','SIL');

In the current working folder, the crossReleaseImport function creates the xrel subfolder
that contains software-in-the-loop (SIL) blocks and subfolders:

• P1_R2015b_sil and P1_R2015b_sil_resources
• P2_R2016a_sil and P2_R2016a_sil_resources
• P3_R2016b_sil and P3_R2016b_sil_resources

3 Incorporate components into current release model

To replace components with SIL or PIL blocks, use the Simulink Editor or the
pil_block_replace command. For example, replace:

• P1 with P1_R2015b_sil.
• P2 with P2_R2016a_sil.
• P3 with P3_R2016b_sil.

When you run a model simulation, the simulation runs the previous release code through the SIL
or PIL blocks.

When you build the Controller model (slbuild('Controller')), the code generator does
not generate new code for the components represented by the SIL or PIL blocks. The model code
calls code generated by previous releases.

The Simulink Code Inspector supports call-site validation for a cross-release SIL or PIL block.
The block provides a specification of the expected function call, which is derived from the
generated code. During analysis, the Simulink Code Inspector compares the expected function
call with the block behavior. For information about analysis limitations, see “S-Function”
(Simulink Code Inspector).

Limitations
The cross-release code integration workflow does not support:

• Export-function models for ERT code.
• Simulink Function and Function Caller blocks across the boundaries of ERT code generated by
different releases.

• The integration of generated code from releases before R2010a.
• The import of generated code from the current release into a previous release (forward

compatibility).
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• The export of files located in the MATLAB root folder of the previous release, for example,
blockset library files.

• The export and import of generated code from models with noninlined S-functions.
• C-API on page 60-2.

At the end of the model build process, the code generation report displays shared files that are
directly used by the integration model, for example, Controller. The report does not display shared
files used by the components of the model, for example, P1 and P2.

If your model has:

• A cross-release SIL or PIL block, you cannot run rapid accelerator mode simulations.
• A Model block that references a model containing a cross-release SIL or PIL block, you cannot run

accelerator mode or rapid accelerator mode simulations.

You can run:

• Top-model SIL simulations of models that contain cross-release SIL or PIL blocks. The models
must not contain cross-release AUTOSAR Model blocks.

• Model block SIL simulations of referenced models that contain cross-release SIL or PIL blocks.
The referenced models must not contain cross-release AUTOSAR Model blocks.

For information about other cross-release AUTOSAR code integration limitations, see “Import
AUTOSAR Code from Previous Releases” on page 50-78.

Simulink.Bus Support
To use a bus object as a data type in cross-release ERT code integration, use one of these approaches.

Appro
ach

Code Export Code Import

Autom
atic

In the previous release, before generating
code, set the DataScope property of the
Simulink.Bus object to Auto. Do not assign
a value to the HeaderFile property.

The code generator creates the
Simulink.Bus data type definition in the
default header file on page 51-14, which is
located in the code generation folder for the
model.

In the current release, before running
crossReleaseImport, set the DataScope
property of the Simulink.Bus object to
Auto.

When you build the integration model, the
build process uses the Simulink.Bus data
type from the header file in the imported
code.
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Appro
ach

Code Export Code Import

Export
ed bus

In the previous release, before generating
code, specify these properties of the
Simulink.Bus object:

• DataScope — Set to Exported.
• HeaderFile — Specify a file name, for

example, prevRelBusType.

The code generator creates
prevRelBusType.h in the shared utility
code folder. This header file contains the
definition for the Simulink.Bus data type.
Use sharedCodeUpdate to add
prevRelBusType.h to the shared code
folder that ExistingSharedCode specifies.

For R2010a and R2010b, the DataScope
property is not available. Do not assign a
value to the HeaderFile property. The code
generator creates the Simulink.Bus data
type definition in modelName_types.h,
which is located in the code generation folder
for the model.

In the current release, before running
crossReleaseImport, set the DataScope
property of the Simulink.Bus object to
Imported.

When you build the integration model that
incorporates the imported SIL or PIL block,
the build process uses the Simulink.Bus
data type definition in prevRelBusType.h.

If the imported code is from R2010a or
R2010b, specify these properties of the
Simulink.Bus object:

• DataScope — Set to Imported.
• HeaderFile — Set to file path for

modelName_types.h, which is in the
imported code folder.

When you build the integration model, the
build process uses the Simulink.Bus data
type definition in modelName_types.h.

Import
ed bus

In the previous release, before generating
code, specify these properties of the
Simulink.Bus object:

• DataScope — Set to Imported.
• HeaderFile — Specify a path to a file

that contains the Simulink.Bus data
type definition, for example, aBusType.h.

For R2010a and R2010b, the DataScope
property is not available. For the
HeaderFile property, specify a path to a file
that contains the Simulink.Bus data type
definition, for example, aBusType.h.

In the current release, after importing
generated code, you do not have to change
the Simulink.Bus.

When you build the integration model that
incorporates the imported SIL or PIL block,
the build process uses the Simulink.Bus
data type definition from aBusType.h.

If the imported code is from R2010a or
R2010b, specify these properties of the
Simulink.Bus object:

• DataScope — Set to Imported.
• HeaderFile — Set to aBusType.h.

When you build the integration model, the
build process uses the Simulink.Bus data
type definition in aBusType.h.

Root-Level I/O Through Global Variables in Generated Code
When imported ERT code from a previous release implements an input or output port through a
global variable, the code that is generated from the integration model depends on the properties of
the signal connected to the port in the integration model.
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If the integration model signal does not map to a generated code variable that has the same name as
the signal in the imported code, the generated code:

• Defines the variable if it is declared but undefined in the imported code.
• Creates additional code to copy data between the variable generated from the integration model

and the variable in the imported code.

If the integration model signal maps to a variable with the same name as the signal in the imported
code, the variable used by the imported code is also used by the code generated from the integration
model. You must use a compatible storage class for the signal.

Storage Class Property Property Value Support
Type Unstructured only
Data access Cannot connect a port implemented as a

Pointer variable in the imported code to a
signal of the same name that is implemented
through a Direct storage class in the integration
model

Cannot connect a port implemented as a Direct
variable in the imported code to a signal of the
same name that is implemented as a Pointer in
the integration model
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Storage Class Property Property Value Support
Data scope If the imported code declares but does not define

the variable (i.e. code is generated from a signal
that uses the Imported value), then one of the
following is required:

• The integration model uses the Exported
value.

• External code defines the variable.

If the imported code defines the variable (i.e.
code is generated from a signal that uses the
Exported value):

• For signals in the integration model that are
connected to root-level I/O ports:

• Set the EnableDataOwnership
configuration parameter to on.

• Use a custom storage class with these
properties:

• Type – Unstructured
• Data access – Direct
• Data scope – Exported
• Owner – Non-empty value that is not

the name of the integration model. For
example, the value can be the name of
the imported component.

• For signals in the integration model that are
not connected to root-level I/O ports, use a
custom storage class with these property
values:

• Data scope - Imported
• Data access - Direct

Communicate Between Current and Previous Release Components
Through Global Data Stores
Current and previous release components can communicate through global data stores associated
with Simulink.Signal objects in the MATLAB base workspace or a Simulink data dictionary. The
workflow described here applies to cross-release ERT code integration.

Code Generation Configuration

Before generating model component code in the old release, configure data store memory to use a
storage class that imports external code.

If a top-model or subsystem build process generates the code, set the Storage class property of the
Simulink.Signal objects to one of these classes:
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• ImportedExtern
• ImportedExternPointer
• ImportFromFile custom storage class

If a model reference build process generates the code, you can also use these classes:

• ExportedGlobal
• ExportToFile custom storage class

Import Configuration

In the current release, before you run crossReleaseImport, define a Simulink.Signal object in
the MATLAB base workspace or a Simulink data dictionary for each global data store of the
component that you want to import:

1 For the object name and the Data type, Complexity, and Dimensions object properties, specify
values that match values of the corresponding object in the component that you want to import.

2 For the Storage class property, specify a value that is compatible. If the previous release value
is ImportedExtern, specify one of these values for the current release:

• ImportedExtern
• ExportedGlobal
• ImportFromFile or ExportToFile custom storage class.

If the previous release value is ImportedExternPointer, then specify
ImportedExternPointer for the current release.

3 For the Identifier property, specify a matching value only if the property is specified for the
object in the component that you want to import.

4 Save the Simulink.Signal objects. The objects are required each time you simulate or build
the imported SIL or PIL block.

For more information, see “Data Stores in Generated Code”.

Parameter Tuning
The cross-release ERT code integration workflow supports parameter tuning in an integration model
that contains component code with tunable parameters from previous releases.

In the current release, before you run crossReleaseImport, for each tunable parameter of the
component that you want to import:

1 Define a Simulink.Parameter object in the MATLAB base workspace or a Simulink data
dictionary.

2 For the object name and the Data type, Complexity, and Dimensions object properties, specify
values that match the previous release object values. If the variable in the imported source code
does not have the same name as the object, for the Identifier property, specify a value that
matches the variable name.

3 If the previous release object uses the GetSet custom storage class, specify:

• A matching value for the Storage class object property.
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• The header file that defines the get and set access functions. For details, see “Control Data
Representation by Configuring Storage Class Properties” on page 38-18 and “Access Data
Through Functions with Storage Class GetSet” on page 38-26.

Support of the GetSet custom storage class from a previous release applies only for R2011a and
later releases.

For code generated by a top-model or subsystem build process in a previous release, these limitations
apply:

• If a tunable parameter specified by a Simulink.Parameter object in the previous release has
storage class set to ExportedGlobal and the storage class of the Simulink.Parameter object
in the current release is also ExportedGlobal, an error occurs when you build the integration
model.

• On a Mac operating system, if a tunable parameter specified by a Simulink.Parameter object in
the previous release has storage class set to ExportedGlobal, you cannot build the integration
model if the storage class of the Simulink.Parameter object in the current release (with the
same name or alias) is ImportedExtern. To work around this limitation, modify the default
settings:

1 Get the build tool from the default toolchain.
tc = coder.make.getDefaultToolchain;
cComp = tc.getBuildTool('C Compiler');

2 Extract the C compiler standard options.
stdMaps = cComp.SupportedStandard.getLangStandardMaps;
optionValues = stdMaps.getCompilerOptions('*');  

3 Remove -fno-common from the standard options for the C and C++ compilers.
optionToRemove = '-fno-common';
optionsToKeep = strrep(optionValues, optionToRemove, '');
c_standard_opts_id = '$(C_STANDARD_OPTS)';

custToolChainOpts = get_param(model,'CustomToolchainOptions');
custToolChainOpts{2} = ...
   strrep(custToolChainOpts{2}, c_standard_opts_id, optionsToKeep);

set_param(model, 'CustomToolchainOptions',custToolChainOpts);

Use Multiple Instances of Code Generated from Reusable Referenced
Model
Using a reusable referenced model, you can specify unique model argument values for each instance
of the referenced model in a parent model. Import previously generated code for the reusable
referenced model into the current release as a parameterized cross-release SIL or PIL block, and
then insert multiple instances of the block into an integration model. For each block instance, you can
specify unique model argument values.

1 Update existing shared code folder.

sharedCodeUpdate(sourceFolder,destinationFolder)
2 Import generated code for the reusable referenced model into the current release as a

parameterized cross-release block, for example, a SIL block.
handleSILBlock = crossReleaseImport(reusableReferencedModelcodeLocation, ...
 configSetIntegrationModel, 'SimulationMode', 'SIL');
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3 In the integration model, replace, for example, two instances of the referenced model with
instances of the cross-release SIL block.

open_system(integrationModel);

blockInstanceName1 = 'refModelInstanceName1';
blockinstanceName2 = 'refModelInstanceName2';

SILBlockFullName = getfullname(handleSILBlock);
replace_block(integrationModel, 'Name', blockInstanceName1, ...
              SILBlockFullName, 'noprompt');
replace_block(integrationModel, 'Name', blockInstanceName2, ...
              SILBlockFullName, 'noprompt');

4 Suppose the reusable referenced model has model arguments paramA and paramB, and the
values for the referenced model instances, refModelInstanceName1 and
refModelInstanceName2, are workspace variables. In this case, you can specify argument
values for the cross-release block instances that are workspace variables.
pathToBlockInstanceName1 = [integrationModel, '/', blockInstanceName1];
pathToBlockInstanceName2 = [integrationModel, '/', blockInstanceName2];

set_param(pathToBlockInstanceName1, 'paramA', 'paramA_instName1');
set_param(pathToBlockInstanceName1, 'paramB', 'paramB_instName1');

set_param(pathToBlockInstanceName2, 'paramA', 'paramA_instName2');
set_param(pathToBlockInstanceName2, 'paramB', 'paramB_instName2');

5 To specify unique model argument values for the block instances in the integration model, assign
values to the workspace variables, paramA_instName1, paramB_instName1,
paramA_instName2, and paramB_instName2.

Compare Simulation Behavior of Model Component in Current Release
and Generated Code from Previous Release
In a previous release, suppose that you developed a model component, generated code for the
component, and tested and deployed the generated code. Now, in the current release, you want to
add features to the model component and use the model component in system development and code
generation. Before you proceed, you can compare the functional behavior of the model component
and the generated code from the previous release.

To test the numerical equivalence between the model component and the generated code from the
previous release, use Simulink Test. With the Test Manager (Simulink Test), you can perform back-to-
back tests and output comparisons:

1 Bring the model component into the current release as a Model block with the Simulation mode
block parameter set to Normal.

2 With the Model block, create a top model that specifies test input data.
3 Import the code generated in the previous release into the current release as a SIL block.
4 With the SIL block, create another top model that specifies the same the test input data.
5 In the Test Manager, create an equivalence test case that runs simulations of the top models and

compares outputs.
6 Run the test case and review results.

For more information, see “Test Two Simulations for Equivalence” (Simulink Test).
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Note If you want to compare the behavior of generated code from the current and previous release,
in step 1, specify these Model block parameters:

• Set Simulation mode to Software-in-the-loop (SIL) or Processor-in-the-loop
(PIL).

• Set Code interface to Top model.

Import AUTOSAR Code from Previous Releases
If you install the Embedded Coder Support Package for AUTOSAR Standard, you can import into the
current release AUTOSAR component code that you generated in a previous release.

When you run crossReleaseImport, the function imports the AUTOSAR code as a cross-release
Model block instead of a SIL or PIL block. The Simulation mode parameter of the Model block is set
to Software-in-the-loop (SIL) or Processor-in-the-loop (PIL). Incorporate the Model
block into the current release model.

These limitations apply:

• The cross-release workflow does not support per-instance memory that accesses NVRAM.
• Tunable parameters must be mapped to AUTOSAR calibration parameters or AUTOSAR internal

calibration parameters.
• If the original model uses variants or symbolic dimensions (dimension variants), the imported

model can use only the same variant and symbolic dimension configuration that was used when
generating the code in the previous release.

See Also
crossReleaseImport | sharedCodeMATLABVersions | sharedCodeUpdate

More About
• “Cross-Release Shared Utility Code Reuse” on page 50-66
• “Generate Shared Utility Code”
• “Generate Shared Utility Code for Fixed-Point Functions”
• “Generate Shared Utility Code for Custom Data Types”
• “Integrate Generated Code by Using Cross-Release Workflow” on page 50-82
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Integration of Code from Multiple Folders
To help you to integrate generated code from multiple code generation folders, this table provides
information about actions you can take.

Action Information Type of Integration
Supported

Use consistent
configuration parameters
across models

If you want to integrate a group of models,
aim to use a configuration set that is
consistent across the models.

For each model, you can create a hash table
from the shared utilities checksum file,
checksummap.mat. The key-value pairs in the
hash table give you information about model
parameters. This information can help you to
determine the parameter values that you must
use across the models. For more information,
see “Manage the Shared Utility Code
Checksum” on page 7-59

To determine whether parameter values are
consistent across the models, for each model,
you can run checks for compliance with
modeling guidelines that specify parameter
values. For more information, see “Model
Advisor Checks for High-Integrity Modeling
Guidelines”.

You can specify the same configuration
parameters for a group of models. For
example, for each model, use a configuration
reference to access the same configuration set
from a data dictionary. When you use the same
configuration set, the generated data types for
each model are the same and the
corresponding rtwtypes.h files are
equivalent except for comments. To integrate
code from the different models, you can
choose a single rtwtypes.h file. For more
information, see:

• “Share a Configuration with Multiple
Models”

• “What Is a Data Dictionary?”

Same-release, cross-
release
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Action Information Type of Integration
Supported

Reuse shared utility code You can reuse data and functions across
software components by specifying a shared
utilities folder for your models. In the
Configuration Parameters dialog box, set
Shared code placement to Shared
location.

If you want software components to share a
utilities folder, generate code from a common
working folder or specify the same code
generation folder through the file generation
control parameter, CodeGenFolder. For more
information, see “Manage Build Process
Folders” on page 50-30.

Identically-named utility files generated in
different releases are functionally equivalent
even if file style or comments differ. For cross-
release code integration, you can use the
ExistingSharedCode parameter to specify
the reuse of shared utility code from an
existing folder. For more information, see:

• “Workflow to Reuse Shared Utility Code”
on page 50-66

• “Existing shared code”

Same release, cross-
release

Avoid generated header
file updates

In general, when you build a model, existing
header files (and source files) in the
_sharedutils or _shared folder are not
regenerated. However, there are instances
when the code generator overwrites existing
header files in the folder. The table in “Code
Generator Header Files” on page 50-44, which
describes header file generation
dependencies, provides information about how
you can avoid overwriting some header files,
for example, rtwtypes.h and
multiword_types.h.

For more information, see:

• “Build Process Folders” on page 50-31
• “Control Placement of rtwtypes.h for

Shared Utility Code” on page 7-58

N/A
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Action Information Type of Integration
Supported

Use cross-release SIL or
PIL block

You can use the cross-release SIL or PIL block
to integrate generated code from previous
releases (R2010a and later) with generated
code from the current release. For more
information, see “Cross-Release Code
Integration” on page 50-68.

Same release, cross-
release

Use CRL and
ExistingSharedCode

You can use the code replacement library
(CRL) and ExistingSharedCode parameter
approaches either separately or jointly:

• The CRL approach supports customization
of code generation and eliminates the
generation of some shared utility files. You
must manage the use of utility files that are
not replaced by CRL. For more information,
see “Develop a Code Replacement Library”
on page 67-20.

• The ExistingSharedCode approach,
which is based on previously generated
utility files, also supports customization
and suppresses regeneration of utility files.
If customization is not required, the
ExistingSharedCode approach is
simpler to set up and manage. For more
information, see “Cross-Release Shared
Utility Code Reuse” on page 50-66.

Same release, cross-
release

See Also

More About
• “Cross-Release Code Integration” on page 50-68
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Integrate Generated Code by Using Cross-Release Workflow
This example shows how to reuse previously generated code by creating a cross-release software-in-
the-loop (SIL) block and incorporating the block within an integration model. For more information
about the workflow, see “Cross-Release Code Integration” on page 50-68.

Generate Code from a Model

In the cross-release code integration workflow, you create a software-in-the-loop (SIL) or processor-
in-the-loop (PIL) block from code that you previously generated.

This example uses generated code from the current release.

model = 'rtwdemo_crossrelease_counter';
close_system(model,0)
load_system(model)
set_param(model, 'SimulationCommand', 'update');
open_system(model)
slbuild(model);

### Starting build procedure for: rtwdemo_crossrelease_counter
### Successful completion of code generation for: rtwdemo_crossrelease_counter

Build Summary

Top model targets built:

Model                         Action          Rebuild Reason                                    
================================================================================================
rtwdemo_crossrelease_counter  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 8.85s
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Identify the build folder that contains the generated code.

buildFolder = RTW.getBuildDir(model).BuildDirectory;

Identify the folder that contains code for shared utilities associated with the generated code.

previousSharedCodeFolder = RTW.getBuildDir(model).SharedUtilsTgtDir;

To reuse generated code from a previous release:

1 On the Simulation tab, in the File section, select Save > Previous Version.
2 In the Save as type field, specify the release and model type.
3 Click Save.
4 Use the previous release to open the saved model, and then generate code.
5 Set the value of buildFolder to the location of the code generated in the previous release.
6 Set the value of previousSharedCodeFolder to the location of the shared utilities generated

in the previous release.

Manage Shared Code

Add the generated shared source code files to a repository folder that is used by the integration
model.

sharedCodeRepo = 'SharedCodeRepo';
mkdir(sharedCodeRepo);
sharedCodeUpdate(previousSharedCodeFolder, sharedCodeRepo, 'Interactive', false);

The following files will be copied from slprj\ert\_sharedutils to SharedCodeRepo\R2021a:

    rtwtypes.h

Files copied from slprj\ert\_sharedutils to SharedCodeRepo\R2021a.

Import Code

Load the integration model.

integrationModel = 'rtwdemo_crossrelease_integration';
close_system(integrationModel, 0);
load_system(integrationModel);

Modify the Simulink configuration set so that it references the existing shared code library.

cs = getActiveConfigSet(integrationModel);
set_param(cs, 'ExistingSharedCode', fullfile(pwd, sharedCodeRepo));

Create the cross-release SIL block.

blockHandle = crossReleaseImport(buildFolder, cs, 'SimulationMode', 'SIL');

### Starting import process for component: rtwdemo_crossrelease_counter_R2021a
### Starting build process for SIL block: rtwdemo_crossrelease_counter_R2021a
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Incorporate Cross-Release SIL Block into Integration Model

To replace a block in the integration model with the cross-release block, use pil_block_replace.
This function preserves the block size, line connections, and priority.

srcBlock = getfullname(blockHandle);
dstBlock = [integrationModel, '/', 'Counter'];
pil_block_replace(srcBlock, dstBlock)
open_system(integrationModel)

Successfully swapped the following blocks: 

untitled/rtwdemo_crossrelease_counter_R2021a_sil
rtwdemo_crossrelease_integration/Counter

Simulate Integration Model

Run a simulation of the integration model.

sim(integrationModel)

### Preparing to start SIL block simulation: rtwdemo_crossrelease_integration/Counter ...
### Starting SIL simulation for component: rtwdemo_crossrelease_counter_R2021a_sil
rtw.connectivity.HostLauncher: started executable with host process identifier 24948
rtw.connectivity.HostLauncher: stopped executable with host process identifier 24948
### Stopping SIL simulation for component: rtwdemo_crossrelease_counter_R2021a_sil
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Tune Parameters

The source model for the cross-release SIL block references two tunable parameters, which are
controlled by Simulink.Parameter objects in the base workspace. Use these parameters to modify the
behavior of the SIL simulation.

countUpper.Value = 30;
countLower.Value = 20;
yout_retuned = sim(integrationModel, 'ReturnWorkspaceOutputs', 'on');

### Preparing to start SIL block simulation: rtwdemo_crossrelease_integration/Counter ...
### Starting SIL simulation for component: rtwdemo_crossrelease_counter_R2021a_sil
rtw.connectivity.HostLauncher: started executable with host process identifier 31628
rtw.connectivity.HostLauncher: stopped executable with host process identifier 31628
### Stopping SIL simulation for component: rtwdemo_crossrelease_counter_R2021a_sil
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Configure Storage Class for Signals in Integration Model

Configure:

• Signal names in the integration model to match the names used in the imported code.
• Complementary storage classes.

In this case, the ticks input and count output are implemented through the ImportedExtern
storage class in the imported code. If the storage class for the signals connected to the input and
output ports of the cross-release block in the integration model is ExportedGlobal, the integration
model must provide the definitions for the variables.

If the signal names do not match, the integration model generates additional code to copy data
between the signal implemented by the integration model and the signal implemented by the
imported code.

hLines = get_param(dstBlock, 'LineHandles');

% Use the code mappings API to configure the storage class on the signals.
cm = coder.mapping.api.get(integrationModel);
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ticksPortHandle = get(hLines.Inport(1), 'SrcPortHandle');
set(ticksPortHandle, 'Name', 'ticks');
addSignal(cm, ticksPortHandle);
setSignal(cm, ticksPortHandle, 'StorageClass', 'ExportedGlobal');

countPortHandle = get(hLines.Outport(1), 'SrcPortHandle');
set(countPortHandle, 'Name', 'count');
addSignal(cm, countPortHandle);
setSignal(cm, countPortHandle, 'StorageClass', 'ExportedGlobal');

Configure Storage Class for Parameters and Data Store Memory in Integration Model

The parameters and data stores are implemented through the ImportedExtern storage class in the
imported code. If you configure the parameters and data stores to use the ExportedGlobal storage
class, the integration model must provide the definitions for the variables.

resetSignal.CoderInfo.StorageClass = 'ExportedGlobal';
countLower.CoderInfo.StorageClass = 'ExportedGlobal';
countUpper.CoderInfo.StorageClass = 'ExportedGlobal';

Generate Code from Integration Model

Once the required shared code is in the shared code repository, remove the previously generated
shared utilities folder.

if isfolder(RTW.getBuildDir(integrationModel).SharedUtilsTgtDir)
    rmdir(RTW.getBuildDir(integrationModel).SharedUtilsTgtDir, 's');
end

Delete the scope and connecting line that do not affect code generation.

scopeBlock = [integrationModel, '/', 'Scope'];
hScopeLines = get_param(scopeBlock, 'LineHandles');
hScopeLine = hScopeLines.Inport(1);
assert(strcmp(get(hScopeLine, 'SegmentType'), 'branch'));
delete_line(hScopeLine);
delete_block(scopeBlock);

Generate code.

slbuild(integrationModel);

### Starting build procedure for: rtwdemo_crossrelease_integration
### Successful completion of code generation for: rtwdemo_crossrelease_integration

Build Summary

Top model targets built:

Model                             Action          Rebuild Reason                                    
====================================================================================================
rtwdemo_crossrelease_integration  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.251s

Examine Call to Imported Code

To examine the cross-release block code within the integration model code, use the rtwtrace utility.
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rtwtrace(dstBlock);

Test Code Generated from Integration Model

Run a top-model software-in-the-loop (SIL) simulation of the integration model. The simulation runs
the code generated from the integration model, which calls the imported code.

Log the simulation output in the workspace.

set_param(integrationModel, 'SimulationMode', 'software-in-the-loop (sil)');
yout_SIL = sim(integrationModel, 'ReturnWorkspaceOutputs', 'on');
plot(yout_SIL.yout{1}.Values);

### Starting build procedure for: rtwdemo_crossrelease_integration
### Successful completion of build procedure for: rtwdemo_crossrelease_integration

Build Summary

Top model targets built:

Model                             Action                       Rebuild Reason                                                      
===================================================================================================================================
rtwdemo_crossrelease_integration  Code generated and compiled  S-function rtwdemo_crossrelease_counter_R2021a_sil does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.974s
### Preparing to start SIL simulation ...
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Updating code generation report with SIL files ...
### Starting SIL simulation for component: rtwdemo_crossrelease_integration
### Stopping SIL simulation for component: rtwdemo_crossrelease_integration
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Compare Simulation Outputs

Compare the outputs from the simulation where only the imported code ran in SIL mode with the
outputs from the simulation where the integration model ran as a top-model in SIL mode.

max(abs(yout_SIL.yout{1}.Values.Data - yout_retuned.yout{1}.Values.Data))

ans =

  uint8

   0
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Use Protected Models from Previous Releases to Perform SIL
Testing and Generate Code

This example shows how you can use a protected model from a previous release (R2018b onwards)
to:

• Test numerical equivalence between the protected model and its previously generated code.
• Generate new code in the current release.

The workflow in this example supports only protected models that specify these system target file
types:

• ERT
• ERT-based
• AUTOSAR Classic
• GRT (Embedded Coder required)
• GRT-based (Embedded Coder required)

Protected Model

Use the pregenerated protected model rtwdemo_crossrelease_protected_counter.slxp,
which was created in R2018b.

The protected model allows the user to:

• Open a read-only view of the model.
• Run simulations.
• Use generated code.

The protected model supports the ERT system target file, and the code that it contains is "Readable
source code" and supports the "Model reference" code interface.

If you want to re-create the protected model with different settings, you can export the model
rtwdemo_crossrelease_unprotected_counter from the current release into a format that can
be used in MATLAB R2018b. In the current release, run these commands:

load_system('rtwdemo_crossrelease_unprotected_counter');
Simulink.exportToVersion('rtwdemo_crossrelease_unprotected_counter', ...
    'rtwdemo_crossrelease_protected_counter.slx', ...
    'R2018b');
close_system('rtwdemo_crossrelease_unprotected_counter', 0);

The protected model was created in MATLAB R2018b by running this command:

Simulink.ModelReference.protect('rtwdemo_crossrelease_protected_counter', ...
    'Mode', 'CodeGeneration', ...
    'OutputFormat', 'MinimalCode', ...
    'ObfuscateCode', false, ...
    'WebView', true, ...
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    'Report', true)

Open Top Model

Open rtwdemo_crossrelease_protected_model, the top model that references the protected
model.

model = 'rtwdemo_crossrelease_protected_model';
open_system(model);

Open Protected Model Report

To open the protected model report, on one of the Model blocks, right click the protected-model
badge icon and then click "Display report". Or, open the report from the command line.

protectedModel = 'rtwdemo_crossrelease_protected_counter';
Simulink.ModelReference.ProtectedModel.displayReport(protectedModel);
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The report shows that the protected model was generated by using Simulink Coder 9.0 (R2018b).

Open Read-Only View

To open a read-only view of the protected model, right click the protected-model badge icon and then
click "Show web view". Or, open the read-only view from the command line.

Simulink.ModelReference.ProtectedModel.displayWebview(protectedModel);
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Merge Shared Utility Code

When you integrate code from multiple releases, you can specify the shared utility code that the final
build uses.

Specify the shared code folder for the top model.

mkdir('sharedCode');
set_param(model, 'ExistingSharedCode', fullfile(pwd, 'sharedCode'));

Use sharedCodeUpdate to merge protected model shared utility files with the shared code folder
content.

Simulink.ModelReference.ProtectedModel.CurrentTarget.clear(protectedModel);
sharedCodeUpdate('rtwdemo_crossrelease_protected_counter.slxp', 'sharedCode', 'Interactive', false);

The following files will be copied from rtwdemo_crossrelease_protected_counter.slxp:slprj\ert\_sharedutils to sharedCode\R2018b:

    rtwtypes.h

Files copied from rtwdemo_crossrelease_protected_counter.slxp:slprj\ert\_sharedutils to sharedCode\R2018b.

Test the Code in the Protected model

The top model references two instances of the protected model. The Simulation mode Model block
parameter for "CounterA" and "CounterB" are Software-in-the-loop (SIL) and Accelerator
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respectively. When you run a top-model simulation, "CounterA" runs generated code from the
protected model while "CounterB" runs the protected model.

simOut = sim(model);
Simulink.sdi.view;

### Preparing to start SIL simulation ...
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Starting SIL simulation for component: rtwdemo_crossrelease_protected_counter
### Stopping SIL simulation for component: rtwdemo_crossrelease_protected_counter

Compare Outputs from Both Model Blocks

To view the simulation output and compare the values of the signals from the Model blocks, use the
Simulation Data Inspector.

simulationRunObj =  Simulink.sdi.getCurrentSimulationRun(model);
counterASignal = getSignalsByName(simulationRunObj, 'counterA');
counterBSignal = getSignalsByName(simulationRunObj, 'counterB');
Simulink.sdi.compareSignals(counterASignal.ID, counterBSignal.ID);
Simulink.sdi.view(Simulink.sdi.GUITabType.CompareRuns);
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Generate Code from Top Model

You can generate code from the top model, referencing the code that is contained in the protected
model.

slbuild(model);

### Starting build procedure for: rtwdemo_crossrelease_protected_model
### Successful completion of build procedure for: rtwdemo_crossrelease_protected_model

Build Summary

Top model targets built:

Model                                 Action                       Rebuild Reason                                    
=====================================================================================================================
rtwdemo_crossrelease_protected_model  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 42.738s

See Also
sharedCodeUpdate

More About
• “Reference Protected Models from Third Parties”
• “SIL and PIL Simulations” on page 80-2
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Compile Code in Another Development Environment
This example shows how you can relocate generated code and compile it in another development
environment. Use packNGo to create a ZIP file that contains generated source code, build
information, and CMake configuration files. In your target development environment, use the
codebuild function to build the final library or executable file.

Configure the Model

Open the model.

rtwdemo_codebuild

Do not automatically compile the code, generate a makefile, or package generated code and artifacts.

set_param('rtwdemo_codebuild', 'GenerateMakefile', 'off');
set_param('rtwdemo_codebuild', 'PackageGeneratedCodeAndArtifacts', 'off');

Generate Code and CMake Configuration Files

Run code generation command.

slbuild('rtwdemo_codebuild');

### Starting serial model reference code generation build
### Successfully updated the model reference code generation target for: rtwdemo_codebuild_ref
### Starting build procedure for: rtwdemo_codebuild
### Successful completion of code generation for: rtwdemo_codebuild

Build Summary

Code generation targets built:

Model                  Action          Rebuild Reason                           
================================================================================
rtwdemo_codebuild_ref  Code generated  rtwdemo_codebuild_ref.c does not exist.  

Top model targets built:
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Model              Action          Rebuild Reason                                    
=====================================================================================
rtwdemo_codebuild  Code generated  Code generation information file does not exist.  

2 of 2 models built (0 models already up to date)
Build duration: 0h 0m 29.238s

Generate the CMakeLists.txt configuration files.

buildFolder = RTW.getBuildDir('rtwdemo_codebuild').BuildDirectory;
codebuild(buildFolder, 'BuildMethod', 'cmake');

Package Generated Code and CMake Configuration Files

Run packNGo, packaging the files hierarchically.

packNGo(buildFolder, 'packType', 'hierarchical', 'nestedZipFiles', false);

Switch to Another Development Environment

This is an optional step. For example, if your current development environment is a Linux computer,
you can copy the zip file to a Windows computer and then perform the subsequent steps on that
computer.

Unzip Source Code and Build Information Files

Unzip the files.

rtwdemo_codebuild_files = unzip('rtwdemo_codebuild.zip');

Identify folder containing unzipped code for the top component.

rtwdemo_codebuild_top_component_folder = fileparts(rtwdemo_codebuild_files{1});

Build Executable File Using Default Toolchain

Identify the default toolchain (based on compiler selected by mex -setup).

defaultToolchain = coder.make.getDefaultToolchain;

Build the executable file.

codebuild(rtwdemo_codebuild_top_component_folder, 'BuildMethod', defaultToolchain);

Check that executable file is produced.

dir(fullfile(rtwdemo_codebuild_top_component_folder, '..', 'rtwdemo_codebuild*'))

rtwdemo_codebuild.exe      
rtwdemo_codebuild_grt_rtw  

Build Executable File Using Default Template Makefile

Select a template makefile for the current platform.

if ispc
    % With ert_vcx64.tmf, you must have Microsoft Visual C++ installed. If
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    % it is not installed, specify ert_lcc64.tmf to use lcc-win64 instead.
    templateMakefile = 'ert_vcx64.tmf';
else
    templateMakefile = 'ert_unix.tmf';
end

Build the executable file.

codebuild(rtwdemo_codebuild_top_component_folder, 'BuildMethod', templateMakefile);

Build Shared Library

On Windows, create a definition file that specifies exported symbols.

if ispc
    exportsFile = fullfile...
        (rtwdemo_codebuild_top_component_folder, 'rtwdemo_codebuild.def');
    fid = fopen(exportsFile, 'w');
    fwrite(fid, ['EXPORTS' newline]);
    fwrite(fid, ['rtwdemo_codebuild_initialize' newline]);
    fwrite(fid, ['rtwdemo_codebuild_step' newline]);
    fwrite(fid, ['rtwdemo_codebuild_terminate' newline]);
    fclose(fid);
end

Build the shared library.

codebuild(rtwdemo_codebuild_top_component_folder, 'BuildVariant', 'SHARED_LIBRARY');

Build Static Library

codebuild(rtwdemo_codebuild_top_component_folder, 'BuildVariant', 'STATIC_LIBRARY');

Use CMake Configuration Files

With the CMakeLists.txt files, you can use the third-party tool CMake to generate makefiles or
workspaces for a compiler environment of your choice. If CMake is installed on your development
computer, build the executable file by running these commands in the MATLAB Command Window:

  cd(rtwdemo_codebuild_top_component_folder)

  !cmake .

  !cmake --build .

See Also
codebuild | packNGo

More About
• “Relocate Code to Another Development Environment” on page 57-41
• “Build Process Customization”
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Generate Code and Simulate Models in a Project
This example shows how to use the code generation template for a new Project. The code generation
project template for Project includes multiple models. The project template also provides utilities (.m
scripts) that help you generate controller code and run simulations of the harness model.

To see the Project API functions for each operation in this example, view the example code.

Create a Project

Create a new Project from the code generation project template.

To create this project from the Simulink start page, in the Command Window, type:

simulink

Select the Code Generation template from the start page, and create the exampleCodeGen project.

Generate Code

Generate controller code for the feedback_control.slx model.

To generate controller code, select the Project Shortcuts tab and select the Generate Controller
Code shortcut.

This shortcut runs the generate_controller_code.m script in the utilities folder of the
project. The script builds the feedback_control.slx model in the controller folder of the
project.

Simulate Models

Simulate the top-level harness feedback_harness.slx model.

To open the harness model for simulation, select the Project Shortcuts tab and select the Feedback
Harness shortcut. This shortcut opens the feedback_harness.slx model in the harnesses folder
of the project.

To simulate the model, click Run.
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Observe Simulation Output

Open the Scope block in the model and observe the simulation output.

To open the scope and observe simulation, in the Simulink window, double-click the Scope block.

Use the Dependency Analyzer View

To view file dependencies, use the Dependency Analyzer view of the project.

From the Dependency Analyzer view, you can:

• Observe file dependencies.
• Hover over the dependency arrows to examine the dependency type.
• Double-click on a file or a model to open it.
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More Information

• “Work with Project Files”
• Simulink.createFromTemplate
• “Automate Startup Tasks”
• “Automate Shutdown Tasks”

Related Examples

• “Create a New Project From a Folder”
• “Create a Project from a Model”
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Generate Code and Simulate Models Programmatically with
Project

This example shows how to use the Project API to create a new project and automate project tasks for
manipulating files. It covers how to programmatically create a blank project, add files and folders, set
up the project path, define project shortcuts, generate code, and simulate the harness model.

Project helps you organize large designs by managing and sharing files and settings, finding required
files, and interacting with source control.

Manage a Model-Based Design Project

The example models provide a controller that positions a camera fixed to a DC motor that tracks a
green ball.

The MBD approach leads to modeling the controller operations:

• Model plant: The plant is a DC motor that rotates to reposition the camera.
• Model controller: The design uses a PID controller with feedback on angular position for

positioning the DC motor.
• Model high-level ball tracking scheduler: The scheduler checks for validity of the position of the

green ball and the saturation of the reference angle. The scheduler handles the instances of no
ball on the screen to track.

The design and Project have the following folders.

Plant -- The plant provides:

• Models with continuous-time dynamic systems that use basic Simulink blocks.
• Models with linear time invariant (LTI) systems that use the LTI system block.
• Import and export of simulation data to and from the workspace
• Loading of parameters into the base workspace that use data dictionary and model callbacks.

Controller -- The controller provides:

• Models with discrete-time dynamic systems that use basic Simulink blocks.
• Models with discrete-time dynamic systems that use the PID Controller Block.
• Enforcement of signal saturation that use a PWM Conversion subsystem.

Ball Tracking -- The ball tracking provides:

• The basic ball tracking algorithm.
• The terminator and ground blocks as placeholders.
• A hybrid controller that generates motor reference angles using Stateflow.

Harnesses -- The harnesses provide top-level simulation of the full system.

Create a Blank Project and Add Files

1. Create a blank project. On the Home tab, click New > Project > Blank Project.
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Alternatively, create this project and use currentProject to get a project object to manipulate the
project from the Command Window:

matlab.project.createProject('modelBasedDesignCodeGenProject');
proj_modelBasedDesignCodeGen = currentProject

proj_modelBasedDesignCodeGen = 
  Project with properties:

                        Name: "modelBasedDesignCodeGenProject"
    SourceControlIntegration: ""
          RepositoryLocation: ""
       SourceControlMessages: [1×0 string]
                    ReadOnly: 0
                    TopLevel: 1
                Dependencies: [1×1 digraph]
                  Categories: [1×1 matlab.project.Category]
                       Files: [1×0 matlab.project.ProjectFile]
                   Shortcuts: [1×0 matlab.project.Shortcut]
                 ProjectPath: [1×0 matlab.project.PathFolder]
           ProjectReferences: [1×0 matlab.project.ProjectReference]
                StartupFiles: [1×0 string]
               ShutdownFiles: [1×0 string]
         DefinitionFilesType: FixedPathMultiFile
                 Description: ""
                  RootFolder: "C:\Users\ktripp\MATLAB\Projects\modelBasedDesignCodeGenProject"
         SimulinkCacheFolder: ""
        ProjectStartupFolder: "C:\Users\ktripp\MATLAB\Projects\modelBasedDesignCodeGenProject"
       SimulinkCodeGenFolder: ""

2. Copy the example files to folders within the Project.

Alternatively, in the Command Window, type:

copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','slproject_codegen_demo'), ...
fullfile(pwd),'f');

3. Add existing files to the project:

• Click the Project Files View button and select All files View.
• Select the folders ball_tracking, controller, harnesses, plant, and utilities, right-

click the icon for one of the folders, and select Add Folder to Project (Including Child Files).

Alternatively, add these files to the project programmatically from the Command Window:

addFolderIncludingChildFiles(proj_modelBasedDesignCodeGen,'ball_tracking');
addPath(proj_modelBasedDesignCodeGen,'ball_tracking');
addFolderIncludingChildFiles(proj_modelBasedDesignCodeGen,'controller');
addPath(proj_modelBasedDesignCodeGen,'controller');
addFolderIncludingChildFiles(proj_modelBasedDesignCodeGen,'harnesses');
addPath(proj_modelBasedDesignCodeGen,'harnesses');
addFolderIncludingChildFiles(proj_modelBasedDesignCodeGen,'plant');
addPath(proj_modelBasedDesignCodeGen,'plant');
addFolderIncludingChildFiles(proj_modelBasedDesignCodeGen,'utilities');
addPath(proj_modelBasedDesignCodeGen,'utilities');

4. Select the work folder, right-click the icon for one of the folders, and select Project Path > Add
to the Project Path (Including Subfolders). If you choose to add this folder to the path, generated
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files (artifacts) from simulation and code generation are available on the project path. If you choose
not to include the generated files in the project, the dependency graph does not display these files.

Alternatively, add this folder to the project path from the Command Window:

addPath(proj_modelBasedDesignCodeGen,'work');

5. To make the project more accessible, define and set properties for project shortcuts. In the Files
View, select the Project tab. Open the utilities folder node.

6. Select the files clean_up_project.m, generate_controller_code.m, and
set_up_project.m, right-click the icon for one of the files, and select Create Shortcut.

7. To set the current working folder, set the simulation cache folder, and run other setup scripts when
you open the project:

• Select the set_up_project.m script.
• Right-click the file.
• Select Run at Startup.

Alternatively, add this setup script to project startup from the Command Window:

addStartupFile(proj_modelBasedDesignCodeGen,fullfile(pwd,'/utilities/set_up_project.m'));

8. To restore previous settings and run other clean-up scripts when you close the project:

• Select the clean_up_project.m script.
• Right-click the file.
• Select Run at Shutdown.

Alternatively, add the clean-up script to project shutdown programmatically from the Command
Window:

addShutdownFile(proj_modelBasedDesignCodeGen,fullfile(pwd,'/utilities/clean_up_project.m'));

9. Reopen the project to run the Startup shortcut.

Alternatively, reload the project and run the set_up_project from the Command Window:

reload(proj_modelBasedDesignCodeGen);
run('set_up_project');

Generate Code for the Controller from the Dependency Graph

1. On the Project tab, click Dependency Analyzer to run a dependency analysis on all the files in
your project.

The dependency graph displays your project structure and the files dependencies. It shows how files
relate to each other. Each item in the graph represents a file, and each arrow is a dependency.

The contents of the work folder do not appear in the dependency graph. This setup simplifies the
view to indicate the dependencies in model files and .m script file.

a. Examine the Properties pane on the right for useful information about your project, such as
required products and problem files.
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b. Use the Zoom In button to zoom into the dependencies map. Use arrow keys or click-drag with the
mouse roller wheel to move around in the map.

c. Hover over the dependency arrows to examine the dependency type. For example, the MATLAB
scripts and functions are being run by model callbacks.

2. Select the MBDController.slx model on the dependency map. Right-click the model and select
Open.

3. When the model opens in Simulink, click the Build button to generate code for the model. Or, use
the generate_controller_code shortcut in the project to generate code.

Alternatively, generate code for the model from the Command Window. For the sake of this example,
set write permissions to MBDController.slxc then generate code for the model:

fileattrib('MBDController.slxc', '+w');
evalc('slbuild(''MBDController'')');

4. Close the project from the Project window.

Alternatively, close this project and run clean_up_project from the Command Window:

run('clean_up_project');
close(proj_modelBasedDesignCodeGen);

See Also

addFile, addFolderIncludingChildFiles, addPath, addReference, addShortcut, 
addLabel, close, createCategory, createLabel, export, findCategory, findFile, 
findLabel, isLoaded, listModifiedFiles, listRequiredFiles, refreshSourceControl, 
reload, removeCategory, removeFile, removeLabel, removePath, removeReference, 
removeShortcut
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More Information

• “Work with Project Files”
• Simulink.createFromTemplate
• “Automate Startup Tasks”
• “Automate Shutdown Tasks”

Related Examples

• “Create a New Project From a Folder”
• “Create a Project from a Model”
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Source Code Generation in Embedded
Coder

• “Generate Code Using Embedded Coder®” on page 51-2
• “Generate Code by Using the Quick Start Tool” on page 51-9
• “Manage File Packaging of Generated Code Modules” on page 51-12
• “Tutorial for Generating C Code from a Control Algorithm for an Embedded System”

on page 51-17
• “Prepare a Control Algorithm Model for C Code Generation” on page 51-18
• “Configure Data Interface in the Generated Code” on page 51-29
• “Partition Functions in Generated Code” on page 51-38
• “Call External C Code from Model and Generated Code” on page 51-47
• “Build Integrated Code Outside the Simulink Environment” on page 51-52
• “Test Generated Code” on page 51-57
• “Evaluate Performance of the Generated Code” on page 51-63
• “Install and Use Cygwin and Eclipse” on page 51-67
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Generate Code Using Embedded Coder®
This example shows how to select a system target file for a Simulink® model, configure model
parameters, generate C code for embedded systems, and view generated files.

The model represents an 8-bit counter that feeds a triggered subsystem that is parameterized by
constant blocks INC, LIMIT, and RESET. Input and Output represent I/O for the model. The
Amplifier subsystem amplifies the input signal by gain factor K, which updates when signal
equal_to_count is true.

1. Open the model.

model='rtwdemo_rtwecintro';
open_system(model)

2. Open the Model Configuration Parameters dialog box.

cs = getActiveConfigSet(model);
openDialog(cs);

3. Select the Code Generation tab.
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4. To select a system target file, in the Target Selection pane, click Browse You can generate code
for a specific target environment or purpose. Some built-in targeting options are provided by system
target files, which control the code generation process for a target environment.
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5. Select the Embedded Real-Time (ERT) system target file and click Apply.

The ERT system target file supports a utility that you can use to specify and prioritize code
generation settings based on your application objectives.

6. In the Code Generation Advisor pane, click Set Objectives.

You can set and prioritize objectives for the generated code. For example, while code traceability
might be a very important criterion for your application, you might not want to prioritize it at the cost
of code execution efficiency.

7. In the Set Objectives pane, select Execution efficiency and Traceability. Click OK.

You can select and prioritize a combination of objectives before generating code.
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8. In the model window, initiate code generation and the build process for the model by using one of
these options:

• Click the Build Model button.
• Press Ctrl+B.
• Invoke the slbuild command from the MATLAB command line.
• Invoke the slbuild command from the MATLAB command line.

9. View the code generation report.

The report includes rtwdemo_rtwecintro.c, associated utility and header files, and traceability
and validation reports.
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This figure contains a portion of rtwdemo_rtwecintro.c
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10. Close the model.

bdclose(model)
rtwdemoclean;

 Generate Code Using Embedded Coder®

51-7



Related Topics

• “Configure Model, Generate Code, and Simulate”
• “Configure a System Target File”
• “Generate Code and Simulate Models in a Project”
• “Generate Code and Simulate Models Programmatically with Project” on page 50-102

See Also

More About
• “Generate Code by Using the Quick Start Tool” on page 51-9
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Generate Code by Using the Quick Start Tool
The Quick Start tool helps you prepare a model for generating readable, efficient code. To start the
tool, open the Embedded Coder app. On the C Code tab, click Quick Start.

After you start the tool, you must answer these questions about the code that you want to generate:

• What is the model or subsystem for code generation?
• What is the type of code output for your generated code?
• Does your application require reentrant, multi-instance code?
• What is the target hardware processor type?
• What is your primary code generation objective?

The tool validates your choices against the model and presents the parameter changes required to
generate code. If you choose to generate code, the tool applies the parameter changes to your
configuration set and generates the code. After code generation, you can view the code generation
report and find information on building, customizing, optimizing, and packaging the code. To further
customize your generated code, click Finish, and then use the Embedded Coder app with the Code
perspective environment. The Code perspective provides the tools to control the names and
representation of the model data and functions in the generated code. For more information, see “C
Code Generation Configuration for Model Interface Elements” on page 33-2.

Quick Start Model Analysis
At each step of the quick start process, the tool validates your model against your selections. The tool
checks for model conditions that prevent you from proceeding with code generation. During the
analysis step, the tool must also examine your model or subsystem for answers to the following
questions. The answers help determine the best configuration for the deployment of your code.

How many sample rates are in your system?

The Quick Start tool evaluates your model to determine the number of periodic sample rates in your
system.

Single rate Your model has only one periodic sample rate. The generated code has a single-entry point
function that runs at the time interval of the sample rate.

Multirate Your model has more than one periodic sample rate. It is possible that the generated code
does not execute at the same time intervals. After the analysis step, you can choose to
generate a single-entry point function for each of the sample rates or generate a different
entry point function for each sample rate.

If you choose to generate multitasking code, the code generator produces multiple entry-
point functions. These functions run as multiple tasks. Each entry-point function is called
at an interval defined by the sample rate that is configured in the model.

If your model contains an asynchronous rate, an additional entry-point function is generated to run at
the specific interrupt time.

For more information about sample rates, see “Time-Based Scheduling and Code Generation”.
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Does your system contain continuous states?

The Quick Start tool evaluates your model for continuous blocks to determine the correct solver to
use.

No If your system does not contain continuous states, the Quick Start tool configures your
model to use a fixed-step discrete solver for code generation if you have not selected one.

Yes If your system does contain continuous states, the Quick Start tool configures your model
to use a fixed-step continuous solver for code generation if you have not selected one. The
tool also selects the SupportContinuous configuration parameter.

For more information on solvers, see “Solver Selection Criteria”.

Did you configure your system for export function calls?

The Quick Start tool evaluates your model to see if scheduler code must be generated.

No If you did not configure your system for export function calls, the generated code includes
code for the system algorithm and the scheduler code.

Yes If you configured your system for export function calls, the generated code includes code
for the system algorithm. You can manually write the scheduler code or generate it from
other models.

For more information, see “Export-Function Models Overview”.

Does your system contain referenced models?

The Quick Start tool evaluates your model to see if it depends on code from other models.

No If your system does not contain referenced models, the generated code does not depend on
code from other models.

Yes If your system contains referenced models, the generated code for your model depends on
other modules generated from referenced models. The code generator can optimize the
generated code because it is aware of the relationship between your model and the
referenced models. When the Quick Start tool applies configuration parameter changes to
your model, it also applies the changes to the referenced models.

For more information, see “Generate Code for Model Reference Hierarchy”.

Configuration Parameter Changes for Models That Have a
Configuration Reference
To apply configuration parameter changes to a model that has an active configuration reference, the
Quick Start tool:

• Creates a Simulink.ConfigSet object QuickStart_timestamp in the workspace or data
dictionary that contains the original configuration set. The new object is a copy of the original
configuration set that has the parameter changes applied.

• Creates a Simulink.ConfigSetRef object that points to the new configuration set object.
• Attaches the new configuration reference to the model and makes it the active configuration.
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• If your system contains referenced models that share your original configuration set, the tool
attaches the new configuration reference to the referenced models and makes the new
configuration reference the active configuration.

To restore the original configuration set, activate the original Simulink.ConfigSetRef object.

Note If the Quick Start tool creates the configuration set object in the MATLAB workspace, you must
save the object to preserve the configuration set after the MATLAB session ends. For more
information, see “Save a Configuration Set”.

Next Steps
After you generate code by using Quick Start tool, possible next steps are:

• “Open Code Generation Report” on page 52-7
• “Preserve Variables in Generated Code” on page 34-2
• “Configure Model for Code Generation Objectives by Using Code Generation Advisor” on page 47-

2
• “Code Appearance”
• “Build Process”
• “Manage Configuration Sets for a Model”
• “Build and Run a Program” on page 57-28
• “Relocate Code to Another Development Environment”

To control the names and representation of the model data and functions in the generated code, use
the Code Mappings editor and the Model Data Editor in the Embedded Coder app. For more
information, see “C Code Generation Configuration for Model Interface Elements” on page 33-2.

See Also

Related Examples
• “Generate C or C++ Code from Stateflow Blocks” (Stateflow)
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Manage File Packaging of Generated Code Modules
The code generator produces code modules. The file packaging configuration controls where the code
generator places code into code modules and header files.

To locate and examine the generated code files, use the Code view or the HTML code generation
report. The code generation report provides hyperlinks in the comments that you can click to view
the generated code in the MATLAB Help browser. For more information, see “Traceability in
Generated Code” on page 77-3.

In this section...
“Generated Code Modules” on page 51-12
“User-Written Code Modules” on page 51-14
“Customize Generated Code Modules” on page 51-14

Generated Code Modules
The code generator creates a build folder in your working folder to store generated source code. The
build folder contains object files, a makefile, and other files created during the code generation
process. The default name of the build folder is model_ert_rtw.

Code Modules and Header Files Affected by File Packaging summarizes the structure of source code
that the code generator produces.

You can customize the generated set of files in several ways:

• File packaging formats: Manage the number of source files generated for your model. Select
model configuration parameter File packaging format. For more information, see “Customize
Generated Code Modules” on page 51-14.

• Nonvirtual subsystem code generation: Instruct the code generator to produce separate functions
within separate code files for nonvirtual subsystems. You can control the names of the functions
and of the code files. For more information, see “Control Generation of Functions for Subsystems”.

• Storage classes: Define and use storage classes that partition generated data structures into
different files based on file names that you specify. For more information, see “Organize Parameter
Data into a Structure by Using Struct Storage Class” on page 33-68.

• Module packaging: Direct the generated code into a required set of .c or .cpp and .h files, and
control the internal organization of the generated files. For details, see “Code Interface
Configuration and Integration”.
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Code Modules and Header Files Affected by File Packaging

File Description
model.c or .cpp Contains entry points for code implementing the model algorithm (for

example, model_step, model_initialize, and model_terminate).
model_private.h Contains local macros and local data that the model and subsystems require.

This file is included in the model.c file as a #include statement. You do not
need to include model_private.h when interfacing handwritten code to the
generated code of a model.

model.h Declares model data structures and a public interface to the model entry-
points and data structures. Provides an interface to the real-time model data
structure (model_M) with accessor macros.

The code generator:

• Produces a separate header file for each Simulink Function block in a
model.

• Includes model.h in the subsystem .c or .cpp files of a model.

If you interface handwritten code to generated code for one or more models,
include model.h for each of those models.

model_data.c or .cpp Contains (if conditionally generated) the declarations for the parameters data
structure, the constant block I/O data structure, and any zero representations
for the model structure data types. If the model does not use these data
structures and zero representations, model_data.c or .cpp is not
generated. These structures and zero representations are declared extern
in model.h.

model_types.h Provides forward declarations for the real-time model data structure and the
parameters data structure. Function declarations of reusable functions can
require these declarations. Provides type definitions for user-defined types
that the model uses.

rtwtypes.h Defines data types, structures, and macros required by generated code. For
more information, see “Control Placement of rtwtypes.h for Shared Utility
Code”.

multiword_types.h Contains type definitions for wide data types and their chunks. File is
generated when multiword data types are used or when you select one or
more of these model configuration parameters:

• MAT-file logging
• External mode

model_reference_types.h Contains type definitions for timing bridges. File is generated for a
referenced model or a model containing Model blocks.

builtin_typeid_types.h Defines an enumerated type corresponding to built-in data types. File is
generated when your model contains a Stateflow chart that uses messages or
when you select one or more of these configuration parameters:

• MAT-file logging
• C API model configuratoin parameter
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File Description
zero_crossing_types.h Contains zero-crossing definitions for models with triggered subsystems

where the trigger is rising, falling, or either. File is generated only if
required by the model.

ert_main.c or .cpp (optional file) If you select model configuration parameter Generate an
example main program, this file is generated. For more information, see
“Generate an example main program”.

rtmodel.h (optional file) If you clear model configuration parameter Generate an
example main program, this file is generated. For more information, see
“Generate an example main program”.

Contains #include directives required by the rt_main.c or
rt_cppclass_main.cpp static main program module. Includes rtmodel.h
to access model-specific data structures and entry points, because the static
main program module is not created at code generation time.

For more information, see “Static Main Program Module” on page 66-8.
model_capi.c or .cpp

model_capi.h

(optional file) Provides data structures that enable a running program to
access model signals, states, and parameters without external mode. To learn
how to generate and use the model_capi.c or .cpp and .h files, see
“Exchange Data Between Generated and External Code Using C API”.

User-Written Code Modules
Code that you write to interface with generated model code usually includes a customized main
module. Base this module on a main program produced by the code generator. This customized main
module can also include interrupt handlers, device driver blocks and other S-functions, and other
supervisory or supporting code. Steps to set up the development environment to support a
customized main module include:

1 Establish a working folder for your own code modules.
2 Put your working folder on the MATLAB path.
3 At minimum, inform the build process about the location of your source and object files with

model configuration parameter Additional build information.
4 Your development process could require generating code for a particular microprocessor or

development board and deploying the code on target hardware with a cross-development system.
To accomplish these goals, make more extensive modifications to the ERT-based system target
file.

For information on how to customize your ERT-based system target file for your production
requirements, see “Target Development”.

Customize Generated Code Modules
Model configuration parameter File packaging format specifies how the code generator packages
generated source code into files. You can set the parameter to Modular, Compact (with separate
data file), and Compact. This table describes the generated files and the removed files for each
file packaging format.
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Generated Files According to File Packaging Format

File Packaging Format Generated Files Removed Files
Modular (default) model.c

subsystem files (optional)

model.h

model_types.h

model_private.h

model_data.c
(conditional)

None

Compact (with separate
data file)

model.c

model.h

model_data.c
(conditional)

model_private.h

model_types.h (conditional, see
Removed Files According to File
Packaging Format)

Compact model.c

model.h

model_data.c

model_private.h

model_types.h (conditional, see
Removed Files According to File
Packaging Format)

This table describes content placement from the removed files.

Removed Files According to File Packaging Format

Removed File Generated Content In File
model_private.h model.c and model.h
model_types.h model.h
model_data.c model.c

You can specify a different file packaging format for each referenced model.

Model configuration parameter Shared code placement interacts with file packaging operations. If
you set Shared code placement to Shared location, the code generator produces separate files
for utility code in a shared location, regardless of the file packaging format. If you set Shared code
placement to Auto, the code generator generates code for utilities according to the file packaging
format selection.

• Modular: Some shared utility files are in the build folder.
• Compact (with separate data file): Utility code is generated in model.c.
• Compact: Utility code is generated in model.c.

File packaging formats Compact and Compact (with separate data file) generate
model_types.h for models containing:
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• A Variant Subsystem block. The model_types.h file includes preprocessor directives defining the
variant objects associated with a variant block.

• Storage classes generating a separate header file.

File packaging formats Compact and Compact (with separate data file) are not compatible
with:

• A model containing a subsystem, which is configured to generate separate source files
• A model containing a noninlined S-function
• A model for which Shared code placement is set to Auto, which uses data objects for which

Data scope is set to Exported

See Also

More About
• “Manage Build Process Folders” on page 50-30
• “Manage Build Process Files” on page 50-34
• “Manage Build Process File Dependencies” on page 50-41
• “Control Placement of Global Data Definitions and Declarations in Generated Files” on page 35-

2
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Tutorial for Generating C Code from a Control Algorithm for an
Embedded System

This guided tutorial uses a series of examples to show the workflow of generating code from a control
algorithm for an embedded system. In each example, you learn how to perform a specific aspect of
code generation or integration. The examples are based on a shared model. Each example has a
unique version of that model and corresponding data set so that you can use the examples
independently. You do not have to run the examples in a specific order. When you transition between
examples, you save the current model so that each example captures your modifications to the model
and model data.

To recover a model in its original state, delete your local copy of the model and model data. The
model data is saved as PCG_Demo_#_data.mat.

Use these hyperlinks to navigate to the examples in the tutorial.

1 “Prepare a Control Algorithm Model for C Code Generation” on page 51-18
2 “Configure Data Interface in the Generated Code” on page 51-29
3 “Partition Functions in Generated Code” on page 51-38
4 “Call External C Code from Model and Generated Code” on page 51-47
5 “Build Integrated Code Outside the Simulink Environment” on page 51-52
6 “Test Generated Code” on page 51-57
7 “Evaluate Performance of the Generated Code” on page 51-63
8 “Install and Use Cygwin and Eclipse” on page 51-67

Third-Party Software
Some of the examples use the Eclipse™ IDE and the Cygwin™/gcc compiler. Instructions to install
and use Eclipse™ and Cygwin™/gcc are available in “Install and Use Cygwin and Eclipse” on page
51-67.

See Also
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Prepare a Control Algorithm Model for C Code Generation
Generate code for a control algorithm model, integrate the generated code with an existing system,
and validate simulation and executable results.

Understand the Model

This example shows and describes the model from behavioral and structural perspectives. The
example also shows how to configure a model for code generation and how to generate code. You
learn how to:

• Understand the functional behavior of the example model.
• Understand how to validate the model.
• Become familiar with model-checking tools.
• Become familiar with configuration options that affect code generation.
• Generate code from a model.

Understand the Functional Design of the Model

This example uses a simple model of a throttle controller. The model features redundancy, which
safety-critical, drive-by-wire applications commonly use. The model highlights a standard model
structure and a set of basic blocks in algorithm design.

In the current configuration, the code that the model generates is not configured for a production
target system. In this example, you change the target configuration and observe the resulting
changes to the format of the generated code.

Inspect the Top-Level Model

Open the example model.

The top-level model consists of:

• Four subsystems: PI_ctrl_1, PI_ctrl_2, Define_Throt_Param, and
Pos_Command_Arbitration.

• Top-level inputs: pos_rqst, fbk_1, and fbk_2.
• Top-level outputs: pos_cmd_one, pos_cmd_two, and ThrotComm.
• Signal routing.
• No transformative blocks. Transformative blocks change the value of a signal, for example, Sum

and Integrator blocks.

The layout shows a basic model architectural style.

• Separation of calculations from signal routing (lines and buses)
• Partitioning into subsystems

This style suits many types of models.
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Inspect Subsystems

Two subsystems represent PI controllers: PI_ctrl_1 and PI_ctrl_2. The subsystems have
identical content and, for now, use identical data. Later, you use the subsystems to learn how the code
generator can create reusable functions.

The PI controllers come from a library, which is a group of related blocks or models that you intend to
reuse. Libraries provide one of two methods for including and reusing models. You see the second
method, model referencing, later in this series.

When you use a library block in a model, you cannot edit the instance of the block in the model.
Instead, edit the block definition in the library. Then, instances of the block in different models remain
consistent.

Open the subsystem PI_ctrl_1.

The Stateflow® chart Pos_Command_Arbitration performs basic error checking on the two
command signals. If the command signals are too far apart, the chart sets the output to a fail_safe
position.

Open Pos_Command_Arbitration.

Inspect Model Configuration Parameter Settings for Code Generation

To prepare a model for code generation, open the Embedded Coder app. Then, set code generation
model configuration parameters. The parameters determine the method that the code generator uses
to generate the code and the resulting code format.

Code Generation Objectives

You can manually configure the model configuration parameters. Alternatively, you can choose from
predefined objectives to automatically configure the model configuration parameters.

You can choose from these high-level code generation objectives:

• Execution efficiency
• ROM efficiency
• RAM efficiency
• Traceability
• Safety precaution
• Debugging

Each objective checks the current model configuration parameters against the recommended values
of the objectives. Each objective also includes a set of Code Generation Advisor checks. You can use
these additional checks to verify that the model configuration parameters are set to create code that
meets the objectives.

Some of the recommendations that the objectives make conflict with the Code Generation Advisor
checks. The order in which you select objectives determines the result. Simulink® resolves conflicts
by satisfying objectives that have a higher priority.

The figure shows how to set the priority to Execution efficiency > ROM efficiency > RAM
efficiency. To open the dialog box, in the Configuration Parameters dialog box, select the Code
Generation pane. Then, click Set objectives.
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You can run the Code Generation Advisor to check the model based on the specified objectives. To
open the Code Generation Advisor, in the C Code tab, click C/C++ Code Advisor.

The Code Generation Advisor creates a list of checks based on the objectives that you select. The first
check reviews current values of the model configuration parameters and suggests alternative values
based on the objectives. The check provides an automated method for setting the parameters to
recommended values.
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Manual Configuration Options

In the Model Configuration Parameters dialog box, these panes are relevant to code generation:

• Solver
• Hardware Implementation
• Code Generation

Solver

Open the Solver pane.

• To generate code for a model, you must set model configuration parameter Type to Fixed-step.
• Parameter Fixed-step size sets the base rate of the system. Set the parameter to the lowest

common multiple of rates in the system.
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• Parameter Solver controls the integration algorithms that the code generator uses.
• To generate an entry-point function for each rate in the system, select parameter Treat each

discrete rate as a separate task.

Hardware Implementation

Open the Hardware Implementation pane.

Use hardware implementation parameters to specify a hardware board. Simulink® adjusts other
settings on the pane, including hidden microprocessor device details, based on your board selection.
To view or adjust the hidden parameter settings, such as the word size and byte ordering, click
Device details.

Code Generation

Open the Code Generation pane.

Use the Code Generation pane to specify the system target file and optimizations. This example
uses the Embedded Coder® system target file (ert.tlc). You can extend that system target file to
create a customized configuration. Some of the basic parameters on the Code Generation pane and
its subpanes include:

System target file

• ert.tlc - "Base" Embedded Coder®
• grt.tlc - "Base" Generic Real-Time Target
• Hardware-specific targets

Make file

Code optimizations

• Remove unused branches from the code and control the creation of temporary variables.
• Control which signals have explicit initialization code.
• Enable and disable use of overflow and division-by-zero protection code.

Code formatting options

• Use of parentheses
• Header file information
• Variable naming conventions

Inclusion of custom code

• C files
• H files
• Object files
• Folder paths

Generation of ASAP2 files
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Save Model Configuration Parameters

You can save the values of model configuration parameters as a MATLAB® function. At the command
prompt, enter:

hCs = getActiveConfigSet('rtwdemo_PCG_Eval_P1');
hCs.saveAs('ConfiguredData');

The MATLAB® function saves a textual representation of the configuration parameter object. You can
use the generated file for archiving or comparing different versions of the files by using traditional
diff tools. You can also visually inspect the content of the file.

You can run the function to set the configuration parameters of other models.

hCs2 = ConfiguredData;
attachConfigSet('myModel', hCs2, true);
setActiveConfigSet('myModel', hCs2.Name);

Understand the Simulation Testing Environment

You test the throttle controller model in a separate model called a test harness. A test harness is a
model that evaluates the control algorithm. Using a test harness:

• Separates the test data from the control algorithm
• Separates the plant or feedback model from the control algorithm
• Provides a reusable environment for multiple versions of the control algorithm

Open the test harness.

A typical simulation testing environment consists of these parts:

• Unit under test
• Test vector source
• Evaluation and logging
• Plant or feedback system
• Input and output scaling

Highlight the unit under test.

The control algorithm is the unit under test. The test harness model references the control algorithm
through a Model block. With Model blocks, you can reuse components. The Model block refers to the
control algorithm by name (rtwdemo_PCG_Eval_P1).
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The Model block enables inclusion (referencing) of a model in another model as a compiled function.
By default, Simulink® compiles the referenced model when you change it. Compiled functions have
these advantages over libraries:

• Large models simulate faster.
• You can simulate compiled functions directly.
• The simulation requires less memory. When you add multiple instances of the model (multiple

Model blocks), only one copy of the compiled model exists in memory.

Highlight the test vector source.

The model uses a Signal Builder block as the test vector source. The block has data that drives the
simulation (pos_rqst) and the expected results that the Verification subsystem uses. This example
uses only one set of test data, though in a typical application you create a test suite that fully
exercises the system.

Highlight Verification.

The test harness compares the simulation results against golden data, which is a set of test results
that indicate the desired behavior for the model. In this model, the V&V Assertion block compares the
simulated throttle value position from the plant against the golden value that the test harness
provides. If the difference between the two signals is greater than 5%, the test fails and the Assertion
block stops the simulation.
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Alternatively, you can evaluate the simulation data after the simulation completes execution. You can
use either MATLAB® scripts or third-party tools to perform the evaluation. Post-execution evaluation
provides greater flexibility in the analysis of the data, though you must wait until execution finishes.
Combining the two methods can yield a highly flexible and efficient test environment.

load_system('rtwdemo_PCGEvalHarness')
open_system('rtwdemo_PCGEvalHarness/Verification')

Highlight the plant/feedback system.

This example models the throttle dynamics by breaking a transfer function down into a canonical
form. You can create plant models to model a specific level of fidelity. Many applications use a
different plant model at each stage of testing.

Highlight scaled input and output.

The subsystems that scale input and output perform these primary functions:

• Select signals to route to the unit under test and to the plant.
• Rescale signals between engineering units and units that the unit under test requires.
• Handle rate transitions between the plant and the unit under test.

Run Simulation Tests

To run the test harness model simulation, click Start or click this hyperlink.

Run the test harness.

The first time the test harness runs, Simulink® must compile the referenced model. You can monitor
the compilation progress in the Command Window.

When the model simulation is complete, Simulink® displays the results in a plot figure.

sim('rtwdemo_PCGEvalHarness')
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The lower-right plot shows the difference between the expected (golden) throttle position and the
throttle position that the plant calculated.

Generate Code

To generate code, open the Embedded Coder app. Then, using one of these techniques:

• In the model, press Ctrl+B.
• In the C Code tab, select Build or Generate Code.
• Click this hyperlink:

Generate code for the model.

The code generator produces several files. The resulting code, though computationally efficient, is not
yet organized for integration into the production environment.

51 Source Code Generation in Embedded Coder

51-26



Examine the Generated Code

The code generator creates multiple files that you can view from the Code view or code generation
report. In addition to the standard C definition and header files, the code generator creates a set of
HTML files. The HTML files provide hyperlinks between the code and the model.

In the Model Explorer, open the HTML Code Browser.

In the generated code, observe that:

• The controller code exists in one function called ModelName_step, which is in the file
rtwdemo_PCG_Eval_P1.c.

• The code generator folds the operations of multiple blocks into one statement of code.
• The function ModelName_initialize initializes variables.
• Data structures define model data (for example, rtwdemo_PCG_Eval_P1_U.pos_rqst).

• rtwdemo_PCG_Eval_P1.c: C file that defines step and initialization functions
• ert_main.c: Example Main file that includes a simple scheduler
• rtwdemo_PCG_Eval_P1.h: H file that contains type definitions of the Simulink® Coder™ data

structures
• PCG_Eval_p1_private.h: File that declares data that only the generated code uses
• rtwdemo_PCG_Eval_P1_types.h: H file that declares the real-time model data structure

For the next example in this series, see “Configure Data Interface in the Generated Code” on page 51-
29.

See Also

More About
• “Support Model Referencing” on page 86-60
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• “Select and Configure C or C++ Compiler” on page 57-3
• “Recommended Settings Summary for Model Configuration Parameters”
• “Signal Groups”
• “Simulink Check”

51 Source Code Generation in Embedded Coder

51-28



Configure Data Interface in the Generated Code
Specify signals, states, and parameters for inclusion in generated code.

Learn how to control these attributes of data in the generated code:

• Name
• Data type
• Data storage class

For information about the example model, see “Prepare a Control Algorithm Model for C Code
Generation” on page 51-18.

Open Example Model

Open the example model, rtwdemo_PCG_Eval_P2.

open_system('rtwdemo_PCG_Eval_P2')

Data Declaration

Most programming languages require that you declare data and functions before using them. The
declaration specifies:

• Scope: The region of the program that has access to the data
• Duration: The period during which the data exist in memory
• Data type: The amount of memory allocated for the data
• Initialization: A value, a pointer to memory, or NULL

The combination of scope and duration is the storage class. If you do not provide an initial value,
most compilers assign a zero value or a null pointer.
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Supported data types include:

• double: Double-precision floating point
• single: Single-precision floating point
• int8: Signed 8-bit integer
• uint8: Unsigned 8-bit integer
• int16: Signed 16-bit integer
• uint16: Unsigned 16-bit integer
• int32: Signed 32-bit integer
• uint32: Unsigned 32-bit integer
• Fixed Point: 8-, 16-, 32-bit word lengths

With storage classes you can:

• Generate exported files, with custom names, that contain global variable declarations and
definitions.

• Import custom header files that contain global variable declarations.
• Generate const or volatile type qualifiers in declarations.
• Represent a parameter as a macro (#define or compiler option).
• Package signals or parameters into flat structures or bit fields.

Control Data in Simulink® and Stateflow®

This example uses data objects to specify code generation settings for data. Alternatively, you can
store the settings in the model by using dialog boxes. Both methods allow full control over the data
type and storage class. You can use both methods in a single model.

This example focuses on these types of data objects:

• Signal
• Parameter
• Bus

The code generator uses the objects from the MATLAB base workspace or a Simulink data dictionary.
You can create and inspect the objects with commands at the command prompt or by using the Model
Data Editor or the Model Explorer with the Code Mappings Editor.

As an example, inspect the definition of the Simulink.Signal object pos_cmd_one, which the
model created in the base workspace:

1 Open the Embedded Coder app.
2 On the Modeling tab, click Model Data Editor.
3 In the Model Data Editor, inspect the Signals tab.
4 Click the Show/refresh additional information button.
5 Next to the Filter contents box, toggle the Filter using selection button.
6 In the model, select the pos_cmd_one signal line. Now, the data table contains two rows: One

that corresponds to the signal line in the model and one that corresponds to the signal object in

51 Source Code Generation in Embedded Coder

51-30



the base workspace. For the row that corresponds to the signal line, the Resolve check box is
selected, which means the signal line acquires settings from the signal object.

7 Optionally, to inspect other properties of the signal object, adjust the setting for the Change
view drop-down list.

8 In the model, select the pos_cmd_one signal line and pause on the ellipsis that appears above or
below the signal line to open the action bar. Click the Add Signal button.

9 Open the Code Mappings Editor, click the Signals tab. Inspect the pos_cmd_one signal
storage class.

Return to the Model Data Editor, toggle the Filter using selection button. Now, the data table
shows these signal lines and signal objects:

• pos_cmd_one
• pos_rqst
• P_InErrMap
• ThrotComm

ThrotComm is a bus signal, which is an instantiation of the Simulink.Bus object
ThrottleCommands. If a bus signal is nonvirtual, the signal appears as a structure in the C code.
Bus objects do not appear in the Model Data Editor. However, you can inspect the object in the Model
Explorer (View > Model Explorer).

As in C, you can use a bus definition (ThrottleCommands) to create multiple instances of the
structure. In a model diagram, a bus signal appears as a wide line with central dashes.

A data object has properties that you configure for simulation and for code generation, including:

• DataType (numeric data type for storage in the generated code)
• StorageClass (storage class for code generation)
• Value (parameter value)
• InitialValue (initial value for signal)
• Alias (alternative name for the data, which the code generator uses)
• Dimensions (size and number of dimensions of parameter or signal value)
• Complexity (numeric complexity)
• Unit (physical units such as cm)
• Min (minimum value)
• Max (maximum value)

Use the property Description to specify custom documentation for data objects.
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Add New Data Objects

You can create data objects for named signals, states, and parameters. To associate a data object with
a construct, the construct must have a name.

The Data Object Wizard tool finds constructs for which you can create data objects, and then creates
the objects for you. The example model includes two signals that are not associated with data objects:
fbk_1 and pos_cmd_two.

To find the signals and create data objects for them:

1. Open the Data Object Wizard.

dataobjectwizard('rtwdemo_PCG_Eval_P2')

2. Click Find to find candidate constructs.

51 Source Code Generation in Embedded Coder

51-32



3. Click Select All to select all candidates.

4. Click Create to create the data objects.

The Data Object Wizard performs the equivalent of the following commands:

fbk_1 = Simulink.Signal;
fbk_1.Dimensions = 1;
fbk_1.DataType = 'double';
outport = get_param('rtwdemo_PCG_Eval_P2/fbk_1','PortHandles');
outport = outport.Outport;
set_param(outport,'MustResolveToSignalObject','on')

pos_cmd_two = Simulink.Signal;
pos_cmd_two.Dimensions = 1;
pos_cmd_two.DataType = 'double';
outport = get_param('rtwdemo_PCG_Eval_P2/PI_ctrl_2','PortHandles');
outport = outport.Outport;
set_param(outport,'MustResolveToSignalObject','on')

Configure Data Objects

Set the data type and storage class for each data object. To configure data object properties, inspect
the appropriate tab in the Model Data Editor. Use the Change view drop-down list to show design
properties (such as data type) and code generation settings (such as storage class).

In the Model Data Editor, inspect the Signals tab and click the Show/refresh additional
information button to display information for the signal objects that the Data Object Wizard created.
Then, configure these properties for the objects:

• fbk_1: Data type double, storage class ImportedExtern
• pos_cmd_two: Data type double, storage class ExportedGlobal

Alternatively, you can use these commands at the command prompt to configure the objects:

fbk_1.DataType = 'double';
fbk_1.StorageClass = 'ImportedExtern';

pos_cmd_two.DataType = 'double';
pos_cmd_two.StorageClass = 'ExportedGlobal';

Control File Placement of Parameter Data

With Embedded Coder®, you can control the file placement of definitions for parameters and
constants. The example model writes the parameter definitions to the file eval_data.c.

To change the placement of parameter and constant definitions, set the data placement options for
the model configuration. In the Configuration Parameters dialog box, configure the options on the
Code Generation > Code Placement pane.

In the example model, inspect the Code Placement pane in the Configuration Parameters dialog box.
The model places data definitions in the file eval_data.c and declarations in the file eval_data.h.

Declare Block Parameters Tunable or Inlined

You can control the default tunability of block parameters in the generated code by setting model
configuration parameter Default parameter behavior.
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For the example model, the default parameter behavior is set to Inlined. By default, block
parameters appear in the code as numeric literal values, not as variables stored in memory. You can
use Simulink.Parameter objects to override inlining and preserve tunability for individual
parameters.

Enable Signal Data Objects in Generated Code

Make sure that the signal data objects (Simulink.Signal) appear in the generated code. For
individual signal lines in the model, select the option Signal name must resolve to Simulink
signal object to explicitly resolve the signal name to a Simulink.Signal object in a workspace or
data dictionary. In the Model Data Editor, set Change view to Code and select the check box in the
Resolve column.

Alternatively, you can select the option for all signals in a model. At the command prompt, use the
disableimplicitsignalresolution function.

View Data Objects in Generated Code

Generate code from the example model.

slbuild('rtwdemo_PCG_Eval_P2');

### Starting build procedure for: rtwdemo_PCG_Eval_P2
### Successful completion of code generation for: rtwdemo_PCG_Eval_P2

Build Summary

Top model targets built:

Model                Action          Rebuild Reason                                    
=======================================================================================
rtwdemo_PCG_Eval_P2  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.722s

Create a code generation report to more easily view the generated files. In the Simulink Editor, select
model configuration parameter Open Model Report.

You can access these generated files:

• rtwdemo_PCG_Eval_P2.c: Defines the step and initialization functions. Uses the defined data
objects.

• eval_data.c: Assigns initial values to the defined parameters. The model configuration
specifically sets the file name.

• eval_data.h: Provides extern declarations of parameter data. The model configuration
specifically sets the file name.

• ert_main.c: Defines scheduling functions.
• rtwdemo_PCG_Eval_P2.h: Contains the type definitions of the default structures that store

signal, state, and parameter data. Due to the data object settings, some data appear in
eval_data.c instead.

• PCG_Eval_p2_private.h: Declares private (local) data for the generated functions.
• rtwdemo_PCG_Eval_P2_types.h: Declares the real-time model data structure.
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• rtwtypes.h: Provides mapping to the data types that Simulink® Coder™ defines (typedef).
Used for integration with external systems.

For example, view the file eval_data.c, which allocates const memory for global variables that
correspond to the Simulink.Parameter objects in the base workspace.

cfile = fullfile('rtwdemo_PCG_Eval_P2_ert_rtw','eval_data.c');
rtwdemodbtype(cfile,'/* Exported data definition */','* [EOF]',1,1)

/* Exported data definition */

/* Const memory section */
/* Definition for custom storage class: Const */
const real_T I_Gain = -0.03;
const real_T I_InErrMap[9] = { -1.0, -0.5, -0.25, -0.05, 0.0, 0.05, 0.25, 0.5,
  1.0 } ;

const real_T I_OutMap[9] = { 1.0, 0.75, 0.6, 0.0, 0.0, 0.0, 0.6, 0.75, 1.0 } ;

const real_T P_Gain = 0.74;
const real_T P_InErrMap[7] = { -1.0, -0.25, -0.01, 0.0, 0.01, 0.25, 1.0 } ;

const real_T P_OutMap[7] = { 1.0, 0.25, 0.0, 0.0, 0.0, 0.25, 1.0 } ;

/*
 * File trailer for generated code.
 *
 * [EOF]

View the code algorithm in the model step function in the file rtwdemo_PCG_Eval_P2.c. The
algorithm uses the data object names directly.

cfile = fullfile('rtwdemo_PCG_Eval_P2_ert_rtw','rtwdemo_PCG_Eval_P2.c');
rtwdemodbtype(cfile,'/* Model step function */',...
    '/* Sum: ''<S2>/Sum3'' incorporates:',1,0);

/* Model step function */
void rtwdemo_PCG_Eval_P2_step(void)
{
  real_T Discrete_Time_Integrator1;
  real_T Discrete_Time_Integrator1_i;
  real_T rtb_IntegralGainShape;

  /* Sum: '<S2>/Sum2' incorporates:
   *  Inport: '<Root>/fbk_1'
   *  Inport: '<Root>/pos_rqst'
   */
  rtb_IntegralGainShape = *pos_rqst - fbk_1;

  /* DiscreteIntegrator: '<S2>/Discrete_Time_Integrator1' */
  if (rtwdemo_PCG_Eval_P2_DWork.Discrete_Time_Integrator1_SYSTE != 0) {
    /* DiscreteIntegrator: '<S2>/Discrete_Time_Integrator1' */
    Discrete_Time_Integrator1 =
      rtwdemo_PCG_Eval_P2_DWork.Discrete_Time_Integrator1_DSTAT;
  } else {
    /* DiscreteIntegrator: '<S2>/Discrete_Time_Integrator1' incorporates:
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     *  Gain: '<S2>/Int Gain1'
     *  Lookup_n-D: '<S2>/Integral  Gain Shape'
     *  Lookup_n-D: '<S3>/Integral  Gain Shape'
     *  Product: '<S2>/Product3'
     */
    Discrete_Time_Integrator1 = I_Gain * look1_binlx(rtb_IntegralGainShape,
      (&(I_InErrMap[0])), (&(I_OutMap[0])), 8U) * rtb_IntegralGainShape * 0.001
      + rtwdemo_PCG_Eval_P2_DWork.Discrete_Time_Integrator1_DSTAT;
  }

  /* End of DiscreteIntegrator: '<S2>/Discrete_Time_Integrator1' */

Without storage classes and other code generation settings that the data objects specify, the
generated code:

• Inlines invariant signals and block parameters when you select these optimizations in the model
configuration parameters

• Places model input and output signals, block states, and tunable parameters in global data
structures

• Does not create global variables that correspond to MATLAB® variables

In contrast, the example code shows that most of the default data structures have been replaced with
user-defined data objects. For example, these signals and parameters appear as global variables in
the code:

• pos_rqst
• fbk_1
• I_Gain
• I_OutMap
• I_InErrMap

However, the local variable rtb_IntegralGainShape and the state variable
rtwdemo_PCG_Eval_P2_DWork.Discrete_Time_Integrator1_DSTAT still use code generator
data structures. Data objects do not exist for these entities.

Store Model Data in Data Dictionary

When you end your MATLAB session, variables that you create in the base workspace do not persist.
To permanently store data objects and bus objects, consider linking the model to a data dictionary.

1 In the example model, on the Modeling tab, under Design, click Link to Data Dictionary.
2 In the Model Properties dialog box, click New.
3 In the Create a New Data Dictionary dialog box, set File name to rtwdemo_PCG_Eval_dict

and click Save.
4 In the Model Properties dialog box, click Apply.
5 Click Migrate data.
6 Click Migrate in response to message about copying referenced variables.
7 Click OK.

Alternatively, to manually migrate the objects into a data dictionary, you can use programmatic
commands:
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% Create a list of the variables and objects that the target
% model uses.
usedVars = {Simulink.findVars('rtwdemo_PCG_Eval_P2').Name};
% Create a new data dictionary in your current folder. Link the model to
% this new dictionary.
dictObj = Simulink.data.dictionary.create('rtwdemo_PCG_Eval_dict.sldd');
set_param('rtwdemo_PCG_Eval_P2','DataDictionary','rtwdemo_PCG_Eval_dict.sldd')
% Import only the target variables from the base workspace to the data
% dictionary.
importFromBaseWorkspace(dictObj,'clearWorkspaceVars',true,'varList',usedVars);
saveChanges(dictObj);

The data dictionary permanently stores the objects that the model uses. To view the contents of the
dictionary, click the model data badge in the lower-left corner of the model, then click the Data
Dictionary link. In the Model Explorer Model Hierarchy pane, select the Design Data node.

The separation of data from the model provides these benefits:

One model, multiple data sets

• Use of different data types to change the targeted hardware (for example, for floating-point and
fixed-point targets)

• Use of different parameter values to change the behavior of the control algorithm (for example,
for reusable components with different calibration values)

Multiple models, one data set

• Sharing of data between Simulink® models in a system
• Sharing of data between projects (for example, transmission, engine, and wheel controllers might

all use the same CAN message data set)

See Also

More About
• “About Data Types in Simulink”
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Control Placement of Global Data Definitions and Declarations in Generated Files” on page 35-

2
• “What Is a Data Dictionary?”
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Partition Functions in Generated Code
This example shows how to associate subsystems in a model with function names and files.

Learn how to:

• Specify function and file names in the generated code.
• Identify the parts of the generated code that are required for integration.
• Generate code for atomic subsystems.
• Identify data that are required to execute a generated function.

For information about the example model and other examples in this series, see “Prepare a Control
Algorithm Model for C Code Generation” on page 51-18.

Atomic and Virtual Subsystems

The example models in “Prepare a Control Algorithm Model for C Code Generation” on page 51-18
and “Configure Data Interface in the Generated Code” on page 51-29 use virtual subsystems. Virtual
subsystems visually organize blocks but do not affect the model functionality. Atomic subsystems
evaluate the blocks included in a model as a unit. With atomic subsystems, you can specify additional
function partitioning information. In a model, atomic subsystems appear with a bold border.

View Changes in Model Architecture

Open the example model rtwdemo_PCG_Eval_P3.

Save a copy of the model to a writable folder.

This example shows how to replace the virtual subsystems with function-call subsystems. Function-
call subsystems:

• Are atomic subsystems
• Enable you to control subsystem execution order
• Execute when a function call signal triggers

By controlling the execution order of the subsystems, you can match the model with an existing
system that has a specific execution order.

The figure identifies the function call subsystems (1) PI_ctrl_1, PI_ctrl_2, and
Pos_Command_Arbitration.
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This version of the model contains the new subsystem Execution_Order_Control (2), which
contains a Stateflow® chart that models the calling functionality of a scheduler. The subsystem
controls the execution order of the function call subsystems through function call signals (3). Later in
this example, you examine how changing the execution order can change the simulation results.

This version of the model contains new Signal Conversion blocks (4) at the outputs of the PI
controllers. With these additional blocks in place, the code generator can generate a single reentrant
function for the PI controllers.

Control Function Location and File Placement in the Generated Code

In “Prepare a Control Algorithm Model for C Code Generation” on page 51-18 and “Configure Data
Interface in the Generated Code” on page 51-29, the code generator creates a single model_step
function that contains the control algorithm code. However, many applications require a greater level
of control over the file placement of functions. By modifying the parameters of atomic subsystems,
you can specify multiple functions within a single model.

The figure shows the subsystem parameters for PI_ctrl_1.
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Treat as atomic unit

• Enables other submenus. For atomic subsystems, this parameter is automatically selected and
disabled.

Sample time

• Specifies a sample time for execution. Not available for function-call subsystems.

Function packaging options

• Auto -- Determines how the subsystem appears in the generated code. This value is the default.
• Inline -- Places the subsystem code inline with the rest of the model code.
• Function -- Generates the code for the subsystem as a function.
• Reusable function -- Generates a reusable (reentrant) function from the subsystem. The

function passes all input and output data through formal parameters. The function does not
directly access global variables.

Function name options

• Selecting Function or Reusable function for Function packaging enables function name
options.

• Auto -- Determines the function.
• Use subsystem name -- Bases the function on the subsystem name.
• User specified -- Applies the specified file name.

File name options

• Selecting Function or Reusable function for Function packaging enables file name options.
• Auto -- Places the function definition in the module generated for the parent system, or, if the

model root is the parent, in model.c.
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• Use subsystem name -- Generates a separate file. The name of the file is the name of the
subsystem or library block.

• Use function name -- Generates a separate file. The name of the file is the name that you
specify with Function name options.

• User specified -- Applies the specified, unique file name.

Function with separate data

• Enabled when you set Function packaging to Function. When selected, the code generator
separates the internal data of the subsystem (for example, signals) from the data of the parent
model. The subsystem owns this separate data.

Generate Reentrant Code

Embedded Coder® supports reentrant code. Reentrant code is a reusable programming routine that
multiple programs can use simultaneously. Reentrant code is used in operating systems and other
system software that uses multithreading to handle concurrent events. Reentrant code does not
maintain state data, so there are no persistent variables in the function. Calling programs maintain
state variables and must pass the state data into the function. Multiple users or processes can share
one copy of a reentrant function.

To generate reentrant code, you must first specify the subsystem as reusable by configuring the
subsystem parameter Function packaging.

In some cases, the configuration of the model prevents reusable code. The table lists common issues.

Cause                                     Solution
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Subsystem output feeds global signal      Add a Signal Conversion block between the 
data                                      subsystem and the global signal.

Generated function receives data          Select Configuration Parameters >
(formal parameters) through pointers      Model Referencing > Pass fixed-size scalar root
                                          inputs by value for code generation.           

Subsystem uses global signal data         Use a port to pass the global data in and out 
in internal algorithm                     of the subsystem.

Use a Mask to Pass Parameter Values into Library Subsystem

To define algorithmic parameter data (such as a gain or coefficient) outside the scope of a reusable
library block or subsystem, you can apply a mask to the block or subsystem and create a mask
parameter. You can then specify a different parameter value for each instance of the block or
subsystem. Each mask parameter appears in the generated code as a formal parameter of the
reentrant function.

In this version of the model, the subsystems PI_ctrl_1 and PI_ctrl_2 are masked. In each mask,
the values of the P and I gains are set by data objects such as I_Gain_2 and P_Gain_2.

Generate Code for Atomic Subsystem

In “Prepare a Control Algorithm Model for C Code Generation” on page 51-18 and “Configure Data
Interface in the Generated Code” on page 51-29, you generate code at the root level of the model.
Alternatively, you can build a specific subsystem.
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To initiate a subsystem build, use the context menu. You can choose from these options:

1 Build This Subsystem: Treats the subsystem as a separate mode and creates the full set of
source C files and header files. This option does not support function-call subsystems.

2 Generate S-Function: Generates C code for the subsystem and creates an S-Function wrapper.
You can then simulate the code in the original model. This option does not support function-call
subsystems.
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3 Export Functions: Generates C code without the scheduling code that comes with the Build
This Subsystem option. Use this option to build subsystems that use triggers, such as function-
call subsystems.

Alternatively, open the Embedded Coder app, select the subsystem and on the C Code tab, click
Build.

Examine Generated Code

This example compares the files that are generated for the full system build with the files that are
generated for exported functions. You also examine how the masked data appears in the code.

Run the build script for the three options. Then, examine the generated files by clicking the
hyperlinks.

1 Generate code from the entire model.
2 Export the function PI_ctrl_1.
3 Export the function Pos_Command_Arbitration.

rtwdemo_PCG_Eval_P3.c

• Full Build: Yes, Step function
• PI_ctrl_1: No
• Pos_Command_Arbitration: No

PI_ctrl_1.c

• Full Build: No
• PI_ctrl_1: Yes, Trigger function
• Pos_Command_Arbitration: No

Pos_Command_Arbitration.c

• Full Build: No
• PI_ctrl_1: No
• Pos_Command_Arbitration: Yes, Init and Function

PI_Ctrl_Reusable.c

• Full Build: Yes
• PI_ctrl_1: Yes
• Pos_Command_Arbitration: No

ert_main.c

• Full Build: Yes
• PI_ctrl_1: Yes
• Pos_Command_Arbitration: Yes

eval_data.c
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• Full Build: Yes(1)
• PI_ctrl_1: Yes(1)
• Pos_Command_Arbitration: No, Eval data not used in diagram

(1) eval_data.c has different content in the full and export function builds. The full build includes
all of the parameters that the model uses. The export function contains only the variables that the
subsystem uses.

Masked Data in the Generated Code

In the file rtwdemo_PCG_Eval_P3.c, the call sites of the reentrant function use the data objects
P_Gain, I_Gain, P_Gain_2, and I_Gain_2 as arguments.

Effect of Execution Order on Simulation Results

By default, Simulink® executes the subsystems in this order:

1 PI_ctrl_1
2 PI_ctrl_2
3 Pos_Command_Arbitration

For this example, you can specify one of two alternative orders of execution. You can then use the test
harness to observe the effect of the execution order on the simulation results. The subsystem
Execution_Order_Control has two configurations that control the execution order. To choose a
configuration, use the subsystem context menu.

Change the execution order and observe the results.

1 Set the execution order to PI_ctrl_1, PI_ctrl_2, Pos_Command_Arbitration.
2 Open the test harness.
3 Run the test harness.
4 Change the execution order to Pos_Command_Arbitration, PI_ctrl_1, PI_ctrl_2.
5 Run the test harness.

The simulation results (throttle position over time) vary slightly depending on the order of execution.
You can see the difference most clearly when the throttle request changes.
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For the next example in this series, see “Call External C Code from Model and Generated Code” on
page 51-47.

See Also

More About
• “Generate Code and Executables for Individual Subsystems” on page 3-5
• “S-Functions and Code Generation” on page 13-2
• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Masking Fundamentals”
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Call External C Code from Model and Generated Code
Call existing, external functions from a simulation or from the generated code by using the Legacy
Code Tool.

Learn how to:

• Evaluate a C function as part of a Simulink® model simulation.
• Call a C function from the code that you generate from a model.

For information about the example model, see “Prepare a Control Algorithm Model for C Code
Generation” on page 51-18.

Replacement Process

Open the example model, rtwdemo_PCG_Eval_P4.

For many Model-Based Design applications, in addition to Simulink® models, a design includes a set
of existing C functions that have been tested and validated. You can integrate these functions into a
Simulink® model and generate code that uses the functions.

In this example, you create a custom Simulink® block that calls an existing C function. You then
include the block in a model and test the overall system through model simulation in Simulink®.

In the example model, you can replace the Lookup blocks (lookup tables) in the PI controllers with
calls to an existing C function. The function is defined in files SimpleTable.c and SimpleTable.h.

View SimpleTable.c.

View SimpleTable.h.

Create Block That Calls C Function

To specify a call to an existing C function, use an S-Function block. You can automate the creation of
the S-Function block by using the Legacy Code Tool. In the tool, you first specify an interface for your
existing C function. The tool then uses that interface to create an S-Function block.

Use the Legacy Code Tool to create an S-Function block for the existing C function in
SimpleTable.c.

1. Create a structure to contain the definition of the function interface.

def = legacy_code('initialize')

You can use the structure def to define the function interface to the existing C code.
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2. Populate the fields of the structure.

3. Create the S-function.

legacy_code('sfcn_cmex_generate',def)

4. Compile the S-function.

legacy_code('compile',def)

5. Create the S-Function block.

legacy_code('slblock_generate',def)

The generated S-Function block calls the C function in SimpleTable.c. You can now use this S-
Function block in models.

6. Create the TLC file.

legacy_code('sfcn_tlc_generate',def)

This command creates a TLC file, which is the component of an S-Function that specifies how to
generate code for the block.

Validate External Code Through Simulation

When you integrate existing C code in a Simulink® model, validate the generated S-Function block.

To validate the replacement of the Lookup blocks, compare the simulation results produced by the
Lookup blocks with the results produced by the new S-Function block.

1. Open the validation model.

• The Sine Wave block produces output values from [-2 : 2].
• The input range of the lookup table is from [-1 : 1].
• The lookup table outputs the absolute value of the input.
• The lookup table clips the output at the input limits.

2. Run the validation model.

The figure shows the validation results. The existing C code and the Simulink® table block produce
the same output values.
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Validate C Code as Part of Simulink® Model

After validating the existing C function code as a standalone component, validate the S-function in
the model. To complete the validation, use a test harness model.

1. Open the test harness.

2. Run the test harness.

The simulation results match the golden values.
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Call C Function from the Generated Code

The code generator uses the TLC file to process the S-Function block like any other block. The code
generator can implement expression folding with the S-Function block, an operation that combines
multiple computations into a single output calculation.

1. Build the full model.

2. Examine the generated code in PI_Control_Reusable.c.

The generated code now calls the SimpleTable C function.

The figures show the generated code before and after the C code integration. Before the integration,
the code calls a generated lookup routine. After the integration, the generated code calls the C
function SimpleTable.
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See Also

More About
• “Integrate C Functions Using Legacy Code Tool”
• “S-Functions and Code Generation” on page 13-2
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Build Integrated Code Outside the Simulink Environment
Identify required files and interfaces for calling generated code in an external build process.

Learn how to:

• Collect files required for building integrated code outside of Simulink®.
• Interface with external variables and functions.

For information about the example model and related examples, see “Prepare a Control Algorithm
Model for C Code Generation” on page 51-18.

Collect and Build Required Data and Files

The code that Embedded Coder® generates requires support files that MathWorks® provides. To
relocate the generated code to another development environment, such as a dedicated build system,
you must relocate these support files. You can package these files in a zip file by using the packNGo
utility. This utility finds and packages the files that you need to build an executable image. The utility
uses tools for customizing the build process after code generation, which include a buildinfo_data
structure, and a packNGo function. These files include external files that you identify in the Code
Generation > Custom Code pane in the Model Configuration Parameters dialog box. The utility
saves the buildinfo MAT-file in the model_ert_rtw folder.

Open the example model, rtwdemo_PCG_Eval_P5.

This model is configured to run packNGo after code generation.

Generate code from the entire model.

To generate the zip file manually:

1 Load the file buildInfo.mat (located in the rtwdemo_PCG_Eval_P5_ert_rtw subfolder).
2 At the command prompt, enter the command packNGo(buildInfo).

The number of files in the zip file depends on the version of Embedded Coder® and on the
configuration of the model that you use. The compiler might require a subset of the files in the zip
file. The compiled executable size (RAM/ROM) depends on the linking process. The linker likely
includes only the object files that are necessary.

Integrating the Generated Code into an Existing System

This example shows how to integrate the generated code into an existing code base. The example
uses the Eclipse™ IDE and the Cygwin™/gcc compiler. The required integration tasks are common to
integration environments.

Overview of Integration Environment

A full embedded controls system consists of multiple hardware and software components. Control
algorithms are just one type of component. Other components can be:

• An operating system (OS)
• A scheduling layer
• Physical hardware I/O
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• Low-level hardware device drivers

Typically, you do not use the generated code in these components. Instead, the generated code
includes interfaces that connect with these components. MathWorks® provides hardware interface
block libraries for many common embedded controllers. For examples, see the Embedded Targets
block library.

This example provides files to show how you can build a full system. The main file is
example_main.c, which contains a simple main function that performs only basic actions to exercise
the code.

View example_main.c.

The file:

• Defines function interfaces (function prototypes).
• Includes files that declare external data.
• Defines extern data.
• Initializes data.
• Calls simulated hardware.
• Calls algorithmic functions.

The order of function execution matches the order of subsystem execution in the test harness model
and in rtwdemo_PCG_Eval_P5.h. If you change the order of execution in example_main.c, results
that the executable image produces differ from simulation results.
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Match System Interfaces

Integration requires matching the Data and Function interfaces of the generated code and the
existing system code. In this example, the example_main.c file imports and exports the data
through #include statements and extern declarations. The file also calls the functions from the
generated code.

Connect Input Data

The system has three input signals: pos_rqst, fbk_1, and fbk_2. The generated code accesses the
two feedback signals through direct reference to imported global variables (storage class
ImportedExtern). The code accesses the position signal through an imported pointer (storage class
ImportedExternPointer).

The handwritten file defineImportedData.c defines the variables and the pointer. The generated
code does not define the variables and the pointer because the handwritten code defines them.
Instead, the generated code declares the imported data (extern) in the file
rtwdemo_PCG_Eval_P5_Private.h. In a real system, the data typically comes from other software
components or from hardware devices.

View defineImportedData.c.

View rtwdemo_PCG_Eval_P5_Private.h.

Connect Output Data

In this example, you do not access the output data of the system. The example “Test Generated Code”
on page 51-57 shows how you can save the output data to a standard log file. You can access the
output data by referring to the file rtwdemo_PCG_Eval_P5.h.

View rtwdemo_PCG_Eval_P5.h.
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Access Additional Data

The generated code contains several structures that store commonly used data including:

• Block state values (integrator, transfer functions)
• Local parameters
• Time

The table lists the common data structures. Depending on the configuration of the model, a
combination of these structures appear in the generated code. The data is declared in the file
rtwdemo_PCG_Eval_P5.h, but in this example, you do not access this data.

Data Type      Data Name     Data Purpose 

Constants      |model_cP|    Constant parameters
Constants      |model_cB|    Constant block I/O
Output         |model_U|     Root and atomic subsystem input
Output         |model_Y|     Root and atomic subsystem output
Internal data  |model_B|     Value of block output
Internal data  |model_D|     State information vectors
Internal data  |model_M|     Time and other system level data
Internal data  |model_Zero|  Zero-crossings
Parameters     |model_P|     Parameters

Match Function Call Interfaces

By default, functions that the code generator generates have a void Func(void) interface. If you
configure the model or atomic subsystem to generate reentrant code, the code generator creates a
more complex function prototype. In this example, the example_main function calls the generated
functions with valid input arguments.

Calls to the function PI_Cntrl_Reusable use a mixture of separate, unstructured global variables
and Simulink® Coder™ data structures. The handwritten code defines these variables. The structure
types are defined in rtwdemo_PCG_Eval_P5.h.

Build Project in Eclipse™ Environment

This example uses the Eclipse™ IDE and the Cygwin™ GCC debugger to build the embedded system.
The example provides installation files for both programs. Software components and versions
numbers are:

• Eclipse™ SDK 3.2
• Eclipse™ CDT 3.3
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• Cygwin™/GCC 3.4.4-1
• Cygwin™/GDB 20060706-2

To install and use Eclipse™ and GCC, see “Install and Use Cygwin and Eclipse” on page 51-67.

You can install the files for this example by clicking this hyperlink:

Set up the build folder.

Alternatively, to install the files manually:

1 Create a build folder (Eclipse_Build_P5).
2 Unzip the file rtwdemo_PCG_Eval_P5.zip into the build folder.
3 Delete the files rtwdemo_PCG_Eval_P5.c, ert_main.c and rt_logging.c, which are

replaced by example_main.c.

You can use the Eclipse™ debugger to step through and evaluate the execution behavior of the
generated C code. See the example “Install and Use Cygwin and Eclipse” on page 51-67.

To exercise the model with input data, see “Test Generated Code” on page 51-57.

Related Topics

• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Generate Shared Library for Export to External Code Base” on page 56-62

See Also

More About
• “Build Process Customization”
• “Customize Post-Code-Generation Build Processing” on page 85-8
• “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 85-18
• “Relocate Code to Another Development Environment” on page 57-41

51 Source Code Generation in Embedded Coder

51-56



Test Generated Code
Validate generated code by using system-level S-functions or by running the code in an external
environment.

Learn about:

• Different methods for testing the generated code
• How to test generated code in Simulink®
• How to test generated code outside of Simulink

For information about the example model and other examples in this series, see “Prepare a Control
Algorithm Model for C Code Generation” on page 51-18.

Validation Methods

Simulink® supports multiple system testing methods for validating the behavior of generated code.

Windows® run-time executable: Generate a Microsoft® Windows® executable and run the
executable from the command prompt.

• Benefit: Easy to create and enables use of a C debugger to evaluate code
• Drawback: Partial emulation of target hardware

Software-in-the-loop (SIL) testing: Use an S-function to include the generated code in the
Simulink model.

• Benefit: Easy to create, enables reuse of the Simulink test environment, and enables use of a C
debugger to evaluate code

• Drawback: Partial emulation of target hardware

Processor in the loop (PIL) testing: Run a non-real-time cosimulation. Simulink executes a portion
of the model (typically a plant model) while the target processor runs a different portion of the model
(typically a controller). After you download code to the target processor, the processor-in-the-loop
technology handles the communication of signals between Simulink and the target during the
cosimulation.

• Benefit: Enables reuse of the Simulink test environment, enables use of a C debugger with the
simulation, and involves the target processor

• Drawback: Requires additional steps to set up the test environment and the processor does not
run in real time

On-target rapid prototyping: Run the generated code on the target processor as part of the full
system.

• Benefit: You can determine actual hardware constraints and test the component within the full
system. The processor runs in real time

• Drawback: Requires hardware and requires additional steps to set up the test environment

External Mode: Run the generated code on the target processor as part of the full system.

• Benefit: You can determine actual hardware constraints and test the component within the full
system
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• Drawback: Requires hardware and requires additional steps to set up the test environment

Reuse Test Data Outside of Simulink®

In other examples in this series, you test the system through simulation in Simulink. The test input
data come from a Signal Builder block in the test harness model.

To test the system outside of Simulink®, you can reuse the test input data.

1 Save the Simulink test data into a file.
2 Format the data in a way that the system code can access.
3 Read the data file as part of the system code procedures.

To use Simulink to perform verification, you can save the test output data from the external
environment in a format that MATLAB® can read.

In this example, the file hardwareInputs.c contains the data from the Signal Builder block in the
test harness model.

Test via Software-in-the-Loop (Model Block SIL)

Create and Configure Model Block for SIL

Simulink can generate code from a Model block, wrap the code into an S-Function, and add the S-
Function back into the model for software-in-the-loop testing.

Open the example model, rtwdemo_PCG_Eval_P6.

Open the test harness model.

The test harness uses a Model block to access the example model. In this example, you run a
software-in-the-loop test on the example model.

1 Right-click the Model block and select Block Parameters (ModelReference).
2 Set Model name to the name of the model that you want to test.

51 Source Code Generation in Embedded Coder

51-58

matlab:rtwdemo_PCGEvalHarnessHTGTSIL


3 Set Simulation mode to Software-in-the-loop (SIL).

The Model block now shows a (SIL) tag.

Configure Models for SIL
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Configure the example model, rtwdemo_PCG_Eval_P6, and the test harness model,
rtwdemo_PCGEvalHarnessHTGTSIL, for SIL simulation by adjusting the hardware implementation
parameters.

Open the example model.

For both models, in the Configuration Parameters dialog box, select the Support long long check
box.

Save a copy of the example model, rtwdemo_PCG_Eval_P6, in your current folder.

Run Model Block SIL

In this example, the test harness model contains a Model block that is configured for SIL simulation.

Open the test harness.

Run the test harness.

The generated code and the simulation yield the same results.

Configure System for Testing via Test Vector Import and Export

This example extends the integration example in “Build Integrated Code Outside the Simulink
Environment” on page 51-52. In this case, example_main.c uses simulated hardware I/O.
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The augmented example_main.c file now uses this execution order:

1. Initialize data (one time)

while < endTime

2. Read the simulated hardware inputs

3. PI_cnrl_1

4. PI_ctrl_2

5. Pos_Command_Arbitration

6. Write the simulated hardware outputs

end while

View example_main.c.

Two functions, plant and hardwareInputs, supply the input test data.

Plant.c: This function, which was generated from the plant portion of the test harness, simulates
the throttle body response to throttle commands.

void Plant(void)

HardwareInputs.c: This function provides the pos_req signal and adds noise from the
Input_Signal_Scaling subsystems into the plant feedback signal.

void hardwareInputs(void)

The handwritten function in WriteDataForEval.c logs output data from the test. After the test is
finished, the function executes and writes the data to the file PCG_Eval_ExternSimData.m. You can
run this script file in MATLAB to access the data. You can then compare the data to the simulated
data from Simulink®.

To enable these additional files, identify them by using Configuration Parameters > Code
Generation > Custom Code > Additional build information.
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Test via Test Vector Import and Export (Eclipse™ Environment)

Before building an executable in the Eclipse™ environment, regenerate the code without the S-
function interface.

Build C code for integration.

To learn how to install and use Eclipse™ and GCC, see “Install and Use Cygwin and Eclipse” on page
51-67.

To install the files for this example automatically, click the hyperlink.

Automatically set up the build folder.

Alternatively, to manually install the files:

1 Create a build folder (Eclipse_Build_P6).
2 Unzip the file rtwdemo_PCG_Eval_P6.zip into the build folder.
3 Delete the files rtwdemo_PCG_Eval_P6.c, ert_main.c, and rt_logging.c, which are

replaced by example_main.c.

Run the control code in Eclipse™. The function in writeDataForEval.c creates the file
eclipseData.m, which contains the output test data. In MATLAB®, load this Eclipse™ data by
running the script file. Then, compare this data with the data from the Simulink® test harness model
by using plot.

For the next example in this series, see “Evaluate Performance of the Generated Code” on page 51-
63.

See Also

More About
• “SIL and PIL Simulations” on page 80-2

51 Source Code Generation in Embedded Coder

51-62



Evaluate Performance of the Generated Code
Learn how characteristics of generated code and RAM/ROM data affect the RAM/ROM metric.

For information about the example model and other examples in this series, see “Prepare a Control
Algorithm Model for C Code Generation” on page 51-18.

Code Evaluation

You can evaluate the generated code based on two primary metrics: execution speed and memory
usage. In some cases, improvement in one metric implies a sacrifice in the other metric. For example,
you can often gain faster execution by consuming more memory.

You can further classify memory usage as ROM (read-only memory) and RAM (random access
memory).

• Accessing data from RAM is faster than accessing data from ROM.
• Executables and data must be stored on ROM because RAM does not maintain data between

power cycles.

This example evaluates memory requirements and divides the memory usage into function and data
components. The example does not evaluate execution speed.

Compiler Information

This evaluation uses the Freescale™ CodeWarrior® compiler.

• Compiler: Freescale™ CodeWarrior®
• Version: 5.5.1.1430
• Target Processor: Power PC 565

View Code Metrics

As described in “Build Integrated Code Outside the Simulink Environment” on page 51-52 and “Test
Generated Code” on page 51-57, the generated code can require the use of utility functions. The
utility functions incur a one-time, fixed cost of memory. Due to this fixed overhead, the data in this
example show memory usage for:

• Algorithms: The C code generated from the Simulink® block diagrams plus the data definition
functions

• Utilities: Functions that are part of the Simulink® Coder™ library source
• Full: The sum of both the algorithm and utilities

Build Options Configuration

The three evaluations in this example use the same build configuration. Freescale™ CodeWarrior®
was configured to minimize memory usage and apply all applicable optimizations.
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Configuration 1: Reusable Functions with Data Type Double

• Source files: PCG_Eval_File_1.zip
• Data Type: All doubles
• Included Data: The project includes all data that the build requires (including data declared as

extern: pos_rqst, fbk_1, and fbk_2)
• Main Function: A modified version of example_main from “Build Integrated Code Outside the

Simulink Environment” on page 51-52
• Function Call Method: Reusable functions for the PI controllers

Memory Usage

            Function    Data
Algorithms  1172 bytes  549 bytes
Utilities   592 bytes   40 bytes
Full        1764 bytes  589 bytes
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Configuration 2: Reusable Functions with Data Type Single

In this configuration, the model data use a single-precision floating-point data type instead of double
precision.

Model Configuration

• Source files: PCG_Eval_File_2.zip
• Data Type: All singles
• Included Data: The project includes all data that the build requires (including data declared as

extern: pos_rqst, fbk_1, and fbk_2)
• Main Function: A modified version of example_main from “Build Integrated Code Outside the

Simulink Environment” on page 51-52
• Function Call Method: Reusable functions for the PI controllers

Memory Usage

            Function    Data
Algorithms  800 bytes   308 bytes
Utilities   592 bytes   40 bytes
Full        1392 bytes  348 bytes

This configuration uses only 56% of the data memory from the first configuration: 308 bytes instead
of 549 bytes. This configuration also uses 68% of the function memory: 800 bytes instead of 1172
bytes. For this system, using single precision instead of double precision does not affect the accuracy
of the control algorithm, so you can use this configuration to achieve more efficient code.

Configuration 3: Nonreusable Functions with Data Type Single

• Source files: PCG_Eval_File_3.zip
• Data Type: All singles
• Included Data: The project includes all data that the build requires (including data declared as

extern: pos_rqst, fbk_1, and fbk_2)
• Main Function: A modified version of example_main from “Build Integrated Code Outside the

Simulink Environment” on page 51-52
• Function Call Method: The function interface is void void so data exchange occurs through

global variables

Memory Usage

            Function    Data
Algorithms  948 bytes   348 bytes
Utilities   592 bytes   40 bytes
Full        1540 bytes  388 bytes

This configuration consumes more data and function memory than the previous configuration.

See Also

More About
• “Generate Static Code Metrics Report for Simulink Model” on page 52-27
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• “Optimization Tools and Techniques” on page 69-7
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Install and Use Cygwin and Eclipse
Use Eclipse™ and Cygwin™, a free software integration development environment (IDE) and free
compiler, for the examples “Build Integrated Code Outside the Simulink Environment” on page 51-52
and “Test Generated Code” on page 51-57.

For information about the example model and other examples in this series, see “Prepare a Control
Algorithm Model for C Code Generation” on page 51-18.

Create an Eclipse CDT Managed Make C Project

1. Open Eclipse.

2. Select File > New > C Project.

3. Use the C Project dialog box to configure the project.

a. Specify the project name.

b. Select the project location.

c. Select the project type as Makefile.

d. Select the Cygwin GCC toolchain and click Finish.
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4. Select Project > Properties. Use Advanced settings to fully configure the project.

a. Select the C/C++ Build properties.

b. On the Builder Settings tab, select Generate Makefiles automatically.

51 Source Code Generation in Embedded Coder

51-68



c. View the Behaviour tab.

d. Select Build on resource save (Auto build).
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5. Compile the generated code with Eclipse.

After you define the files, Eclipse determines the main function and builds the project with the
managed make environment. The build details appear in the Console window.

Use Eclipse Debugger with the Generated Code

1. Select Run > Debug Configurations.

2. Use the Debug Configurations dialog box to configure the debugger.

a. Select C/C++ Application.

b. Click the new configuration button.

c. Select the project.
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d. Click Apply. Do not click Run.

If required, select the executable. Eclipse automatically finds the exe file.

3. To start the debugger, from the primary Eclipse window, select Run > Debug.

During the build process, Cygwin creates a virtual drive, /cygdrive/c/. To run the debugger,
Eclipse either remaps the drive or locates the files. After locating the first file, Eclipse finds the
remaining files.

4. Run the debugger on the generated code.
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Use Eclipse Debugger Commands

You can use these commands from the debugger context menu:

• F5: Step into
• F6: Step over
• F7: Step out
• F8: Resume
• Ctrl+Shift+B: Toggle break point
• Ctrl+Shift+R: Run to line
• Shift+F5: Use Step Filters

See Also

More About
• “Manage Build Process Folders” on page 50-30
• “Manage Build Process Files” on page 50-34
• “Manage Build Process File Dependencies” on page 50-41
• “Manage File Packaging of Generated Code Modules” on page 51-12
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Report Generation in Embedded Coder

• “Reports for Code Generation” on page 52-2
• “Generate a Code Generation Report” on page 52-5
• “Generate Code Generation Report After Build Process” on page 52-6
• “Open Code Generation Report” on page 52-7
• “Generate Code Generation Report Programmatically” on page 52-8
• “Package and Share the Code Generation Report” on page 52-9
• “Web View of Model in Code Generation Report” on page 52-10
• “Analyze the Generated Code Interface” on page 52-13
• “Static Code Metrics” on page 52-23
• “Generate Static Code Metrics Report for Simulink Model” on page 52-27
• “Generating a Static Code Metrics Report for Code Generated from MATLAB Code”

on page 52-31
• “Analyze Code Replacements in Generated Code” on page 52-34
• “Document Generated Code with Simulink Report Generator” on page 52-36
• “Get Code Description of Generated Code” on page 52-42
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Reports for Code Generation
In this section...
“HTML Code Generation Report Location” on page 52-2
“HTML Code Generation Report for Referenced Models” on page 52-2
“HTML Code Generation Report Extensions” on page 52-3

The code generator software produces an HTML code generation report so that you can view and
analyze the generated code. When your model is built, the code generation process produces an
HTML file that is displayed in an HTML browser or in the Model Explorer. The code generation report
includes:

• The Summary section that contains model and code information, including Author, Tasking
Mode, System Target File, Hardware Device Type, and code generation objectives information.
The Configuration settings at the time of code generation link opens a noneditable view of
the Configuration Parameters dialog box. The dialog box shows the Simulink model settings at the
time of code generation, including TLC options.

• The Subsystem Report section that contains information on nonvirtual subsystems in the model.
• In the Generated Files section on the Contents pane, you can click the names of source code
files generated from your model to view their contents in a MATLAB Web browser window. In the
displayed source code, global variables are hypertext that links to their definitions.

For an example, see “Generate a Code Generation Report” on page 52-5.

If you have a Simulink Report Generator license, you can document your code generation project in
multiple formats, including HTML, PDF, RTF, Microsoft Word, and XML. For an example of how to
create a Microsoft Word report, see “Document Generated Code with Simulink Report Generator” on
page 52-36.

HTML Code Generation Report Location
The default location for the code generation report files is in the html subfolder of the build folder,
model_target_rtw/html/. target is the name of the System target file specified on the Code
Generation pane. The default name for the top-level HTML report file is
model_codegen_rpt.html or subsystem_codegen_rpt.html. For more information on the
location of the build folder, see “Manage Build Process Folders”.

HTML Code Generation Report for Referenced Models
To generate a code generation report for a top model and code generation reports for each
referenced model, you need to specify the Create code generation report on the Code Generation
> Report pane for the top model and each referenced model. You can open the code generation
report of a referenced model in one of two ways:

• From the top-model code generation report, you can access the referenced model code generation
report by clicking a link under Referenced Models in the left navigation pane. Clicking a link
opens the code generation report for the referenced model in the browser. To navigate back to the
top model code generation report, use the Back button at the top of the left navigation pane.

• In the referenced model diagram window, on the C Code tab, click Open Report.
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For more information, see “Generate Code for Model Reference Hierarchy”.

HTML Code Generation Report Extensions
If you have an Embedded Coder license, the code generator enhances the HTML code generation
report. Configure your model to include the following sections in the report:

• The Code Interface Report section provides information about the generated code interface,
including model entry-point functions and input/output data. For more information, see “Analyze
the Generated Code Interface” on page 52-13.

• The Traceability Report section enables you to account for Eliminated / Virtual Blocks that
are untraceable versus the listed Traceable Simulink Blocks / Stateflow Objects / MATLAB
Scripts. This section provides a complete mapping between model elements and code. For more
information, see “Customize Traceability Reports” on page 77-30.

• The Static Code Metrics Report section provides generated code statistics. Metrics are
estimated from static analysis of the generated code. To generate a static code metrics report
without generating a code generation report, use the function
coder.report.generateCodeMetrics. For more information, see “Static Code Metrics” on
page 52-23.

• The Code Replacements Report section enables you to account for code replacement library
(CRL) functions that were used during code generation, providing a mapping between each
replacement instance and the Simulink block that triggered the replacement. For more
information, see “Analyze Code Replacements in Generated Code” on page 52-34.

• The Coder Assumptions section provides a list of:

• Code generation assumptions for your target hardware that you can check.
• Expected results for the assumption checks.

For more information, see “Check Code Generation Assumptions” on page 56-12.
• The model Web view displays an interactive model diagram within the code generation report and

supports traceability between the source code and the model. You can then share your model and
generated code outside of the MATLAB environment. For more information, see “Web View of
Model in Code Generation Report” on page 52-10.

On the Contents pane, in the Generated Files section, you can click the names of source code files
generated from your model to view their contents in a MATLAB Web browser window. In the
displayed source code:

• If you enable code-to-model traceability, hyperlinks within the displayed source code navigate to
the blocks or subsystems from which the code is generated. For more information, see “Code-to-
Model Traceability” on page 77-8.

• If you enable model-to-code traceability, you can navigate to the generated code for a block in the
model. For more information, see “Model-to-Code Traceability” on page 77-10.

• If you set the Code coverage tool parameter on the Code Generation > Verification pane, you
can view the code coverage data and annotations. For more information, see “Configure Code
Coverage with Third-Party Tools” on page 83-8.

• If you select the Generate static code metrics check box on the Code Generation > Report
pane, you can view code metrics information and navigate to code definitions and declarations in
the generated code. For more information, see “View Static Code Metrics and Definitions Within
the Generated Code” on page 52-25.
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Note To view the contents of your generated code and navigate between model and code, you can
also use the Code view in the Code perspective. In the perspective, click the Code tab in the bottom-
right corner.

See Also

Related Examples
• “Verify Generated Code by Using Code Tracing” on page 77-2
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Generate a Code Generation Report
To generate a code generation report when the model is built:

1 On the C Code tab, from the Open Report list, select Report Options. The Configuration
Parameters dialog box opens with the Code Generation > Report pane visible.

2 Select the Create code generation report parameter.
3 If you want the code generation report to automatically open after generating code, select the

Open report automatically parameter (which is enabled by selecting Create code generation
report).

4 Generate code.

The build process writes the code generation report files to the html subfolder of the build folder
(see “HTML Code Generation Report Location” on page 52-2). Next, the build process automatically
opens a MATLAB Web browser window and displays the code generation report.

To open an HTML code generation report at any time after a build, see “Open Code Generation
Report” on page 52-7 and “Generate Code Generation Report After Build Process” on page 52-6.
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Generate Code Generation Report After Build Process
After generating code, if you did not configure your model to create a code generation report, you can
generate a code generation report without rebuilding your model.

1 In the model diagram window, on the C Code tab, select Open Report.
2 If your current working folder contains the code generation files the following dialog opens.

Click Generate Report.
3 If the code generation files are not in your current working folder, this dialog box opens.

Enter the full path of the build folder for your model, ../model_target_rtw and click Open
Report.

The software generates a report, model_codgen_rpt.html, from the code generation files in the
build folder you specified.

Note An alternative method for generating the report after the build process is complete is to
configure your model to generate a report and build your model. In this case, the software generates
the report without regenerating the code.
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Open Code Generation Report
You can refer to existing code generation reports at any time. If you generated a code generation
report, in the Simulink Editor, open the report by clicking Open Report on the C Code tab. A
Simulink Coder license is required to view the code generation report. An Embedded Coder license is
required to view a code generation report enhanced with Embedded Coder features.

If your current working folder does not contain the code generation files and the code generation
report, the following dialog box opens:

Enter the full path of the build folder for your model, ../model_target_rtw and click Open
Report.

Alternatively, you can open the code generation report (model_codegen_rpt.html or
subsystem_codegen_rpt.html) manually into a MATLAB Web browser window, or in another Web
browser. For the location of the generated report files, see “HTML Code Generation Report Location”
on page 52-2.

Limitation
After building your model or generating the code generation report, if you modify legacy or custom
code, you must rebuild your model or regenerate the report for the code generation report to include
the updated legacy source files. For example, if you modify your legacy code, and then use the Open
Report button to open an existing report, the software does not check if the legacy source file is out
of date compared to the generated code. Therefore, the code generation report is not regenerated
and the report includes the out-of-date legacy code. This issue also occurs if you open a code
generation report using the coder.report.open function.

To regenerate the code generation report, do one of the following:

• Rebuild your model.
• Generate the report using the coder.report.generate function.
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Generate Code Generation Report Programmatically
At the MATLAB command line, you can generate, open, and close an HTML Code Generation Report
with the following functions:

• coder.report.generate generates the code generation report for the specified model.
• coder.report.open opens an existing code generation report.
• coder.report.close closes the code generation report.
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Package and Share the Code Generation Report
In this section...
“Package the Code Generation Report” on page 52-9
“View the Code Generation Report” on page 52-9

Package the Code Generation Report
To share the code generation report, you can package the code generation report files and supporting
files into a zip file for transfer. The default location for the code generation report files is in two
folders:

• /slprj
• html subfolder of the build folder, model_target_rtw, for example

rtwdemo_counter_grt_rtw/html

To create a zip file from the MATLAB command window:

1 In the Current Folder browser, select the two folders:

• /slprj
• Build folder: model_target_rtw

2 Right-click to open the context menu.
3 In the context menu, select Create Zip File. A file appears in the Current Folder browser.
4 Name the zip file.

Alternatively, you can use the MATLAB zip command to zip the code generation report files:

zip('myzip',{'slprj','rtwdemo_counter_grt_rtw'})

Note If you need to relocate the static and generated code files for a model to another development
environment, such as a system or an integrated development environment (IDE) that does not include
MATLAB and Simulink products, use the code generator pack-and-go utility. For more information,
see “Relocate Code to Another Development Environment”.

View the Code Generation Report
To view the code generation report after transfer, unzip the file and save the two folders at the same
folder level in the hierarchy. Navigate to the model_target_rtw/html/ folder and open the top-
level HTML report file named model_codgen_rpt.html or subsystem_codegen_rpt.html in a
Web browser.
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Web View of Model in Code Generation Report
In this section...
“About Model Web View” on page 52-10
“Generate HTML Code Generation Report with Model Web View” on page 52-10
“Model Web View Limitations” on page 52-12

About Model Web View
To review and analyze the generated code, it is helpful to navigate between the code and model. You
can include a Web view of the model within the HTML code generation report. You can then share
your model and generated code outside of the MATLAB environment. When you generate the report,
the Web view includes the block diagram attributes displayed in the Simulink Editor, such as, block
sorted execution order, signal properties, and port data types.

A Simulink Report Generator license is required to include a Web view (Simulink Report Generator)
of the model in the code generation report.

Browser Requirements for Web View

Web view requires a Web browser that supports Scalable Vector Graphics (SVG). Web view uses SVG
to render and navigate models.

You can use the following Web browsers:

• Mozilla Firefox Version 1.5 or later, which has native support for SVG. To download the Firefox
browser, go to www.mozilla.com/.

• The Microsoft Internet Explorer® Web browser with the Adobe® SVG Viewer plug-in. To download
the Adobe SVG Viewer plug-in, go to www.adobe.com/svg/.

• Apple Safari Web browser

Generate HTML Code Generation Report with Model Web View
This example shows how to create an HTML code generation report which includes a Web view of the
model diagram.

1 Open the rtwdemo_mdlreftop model.
2 Open the Configuration Parameters dialog box and navigate to the Code Generation pane.
3 Specify ert.tlc for the System target file parameter.
4 Open the Code Generation > Report pane.
5 Select the following parameters:

• Create code generation report
• Open report automatically
• Generate model Web view

6 Select the parameters Code-to-model and Model-to-code.

Note These settings specify only the top model, not referenced models.
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7 Open the Configuration Parameters for the referenced model, rtwdemo_mdlrefbot and perform
steps 3–6.

8 Save the models, rtwdemo_mdlreftop and rtwdemo_mdlrefbot.
9 From the top model diagram, press Ctrl+B. After building the model and generating code, the

code generation report for the top model opens in a MATLAB Web browser.
10 In the left navigation pane, select a source code file. The corresponding source code is displayed

in the right pane and includes hyperlinks.

11 Click a link in the code. The model Web view displays and highlights the corresponding block in
the model.

12 To highlight the generated code for a referenced model block in your model, click CounterB. The
corresponding code is highlighted in the source code pane.

Note You cannot open the referenced model diagram in the Web view by double-clicking the
referenced model block in the top model.

13 To open the code generation report for a referenced model, in the left navigation pane, below
Referenced Models, click the link, rtwdemo_mdlrefbot. The source files for the referenced
model are displayed along with the Web view of the referenced model.

14 To go back to the code generation report for the top model, at the top of the left navigation pane,
click the Back button until the top model’s report is displayed.
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For more information about exploring a model in a Web view, see “Navigate the Web View” (Simulink
Report Generator).

For more information about navigating between the generated code and the model diagram, see
“Trace Simulink Model Elements in Generated Code” on page 77-8.

Model Web View Limitations
The HTML code generation report includes the following limitations when using the model Web view:

• Code is not generated for virtual blocks. In the model Web view of the code generation report,
when tracing between the model and the code, when you click a virtual block, it is highlighted
yellow.

• In the model Web view, you cannot open a referenced model diagram by double-clicking the
referenced model block in the top model. Instead, open the code generation report for the
referenced model by clicking a link under Referenced Models in the left navigation pane.

• Stateflow truth tables, events, and links to library charts are not supported in the model Web view.
• Searching in the code generation report does not find or highlight text in the model Web view.
• If you navigate from the actual model diagram (not the model Web view in the report), to the

source code in the HTML code generation report, the model Web view is disabled and not visible.
To enable the model Web view, open the report again, see “Open Code Generation Report”.

• For a subsystem build, the traceability hyperlinks of the root level inport and outport blocks are
disabled.

• “Traceability Limitations” on page 77-7 that apply to tracing between the code and the actual
model diagram.
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Analyze the Generated Code Interface
In this section...
“Code Interface Report Overview” on page 52-13
“Generating a Code Interface Report” on page 52-13
“Navigating Code Interface Report Subsections” on page 52-16
“Interpreting the Entry-Point Functions Subsection” on page 52-16
“Interpreting the Inports and Outports Subsections” on page 52-19
“Interpreting the Interface Parameters Subsection” on page 52-20
“Interpreting the Data Stores Subsection” on page 52-21
“Code Interface Report Limitations” on page 52-21

Code Interface Report Overview
When you select the Create code generation report option for an ERT-based model, a Code
Interface Report section is automatically included in the generated HTML report. The Code
Interface Report section provides documentation of the generated code interface, including model
entry-point functions and interface data, for consumers of the generated code. The information in the
report can help facilitate code review and code integration.

The code interface report includes the following subsections:

• Entry-Point Functions — interface information about each model entry-point function, including
model_initialize, model_step, and (if applicable) model_reset and model_terminate.

• Inports and Outports — interface information about each model inport and outport.
• Interface Parameters — interface information about tunable parameters that are associated

with the model.
• Data Stores — interface information about global data stores and data stores with non-auto

storage that are associated with the model.

For limitations that apply to code interface reports, see “Code Interface Report Limitations” on page
52-21.

For illustration purposes, this section uses the following models:

• rtwdemo_configinterface (with the ExportedGlobal Storage Class button selected in the
model window) for examples of report subsections

• rtwdemo_mrmtbb for examples of timing information
• rtwdemo_fcnprotoctrl for examples of function argument and return value information

Generating a Code Interface Report
To generate a code interface report for your model:

1 Open your model, go to the Code Generation pane of the Configuration Parameters dialog box,
and select ert.tlc or an ERT-based System target file, if one is not already selected.

2 Go to the Code Generation > Report pane of the Configuration Parameters dialog box and
select the option Create code generation report, if it is not already selected. The
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rtwdemo_configinterface, rtwdemo_mrmtbb, and rtwdemo_fcnprotoctrl models used in
this section select multiple Report pane options by default. But selecting only Create code
generation report, generates a Code Interface Report section in the HTML report.

Alternatively, you can programmatically select the option by issuing the following MATLAB
command:

set_param(bdroot, 'GenerateReport', 'on')

If the Code-to-model parameter is selected, the generated report contains hyperlinks to the
model. Leave this value selected unless you plan to use the report outside the MATLAB
environment.

3 Build the model. If you selected the Report pane option Open report automatically, the code
generation report opens automatically after the build process is complete. (Otherwise, you can
open it manually from within the model build folder.)

4 To display the code interface report for your model, go to the Contents pane of the HTML report
and click the Code Interface Report link. For example, here is the generated code interface
report for the model rtwdemo_configinterface (with the ExportedGlobal Storage Class
button selected in the model window).
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For help navigating the content of the code interface report subsections, see “Navigating Code
Interface Report Subsections” on page 52-16. For help interpreting the content of the code interface
report subsections, see the sections beginning with “Interpreting the Entry-Point Functions
Subsection” on page 52-16.
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Navigating Code Interface Report Subsections
To help you navigate code interface descriptions, the code interface report provides collapse/expand
tokens and hyperlinks, as follows:

• For a large subsection, the report provides [-] and [+] symbols that allow you to collapse or
expand that section. In the example in the previous section, the symbols are provided for the
Inports and Interface Parameters sections.

• Several forms of hyperlink navigation are provided in the code interface report. For example:

• The Table of Contents located at the top of the code interface report provides links to each
subsection.

• You can click each function name to go to its definition in model.c.
• You can click each function's header file name to go to the header file source listing.
• If you selected the Code-to-model parameter for your model, to go to the corresponding

location in the model display, you can click hyperlinks for any of the following:

• Function argument
• Function return value
• Inport
• Outport
• Interface parameter (if the parameter source is a block)
• Data store (if the data store source is a Data Store Memory block)

For backward and forward navigation within the HTML code generation report, use the Back and
Forward buttons above the Contents section in the upper-left corner of the report.

Interpreting the Entry-Point Functions Subsection
The Entry-Point Functions subsection of the code interface report provides the following interface
information about each model entry-point function, including model_initialize, model_step, and
(if applicable) model_reset and model_terminate.

Field Description
Function: Lists the function name. You can click the function name to go to its

definition in model.c.
Prototype Displays the function prototype, including the function return value, name,

and arguments.
Description Provides a text description of the function's purpose in the application.
Timing Describes the timing characteristics of the function, such as how many

times the function is called, or if it is called periodically, and at what time
interval. For a multirate timing example, see the following
rtwdemo_mrmtbb report excerpt.
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Field Description
Arguments If the function has arguments, displays the number, name, data type, and

Simulink description for each argument. If you select the Code-to-model
parameter for your model, you can click the hyperlink in the description to
go to the block corresponding to the argument in the model display. For
argument examples, see the rtwdemo_fcnprotoctrl report excerpt
below.

Return value If the function has a return value, this field displays the return value data
type and Simulink description. If you selected the Code-to-model
parameter for your model, you can click the hyperlink in the description to
go to the block corresponding to the return value in the model display. For
a return value example, see the following rtwdemo_fcnprotoctrl report
excerpt.

Header file Lists the name of the header file for the function. You can click the header
file name to go to the header file source listing.

For example, here is the Entry-Point Functions subsection for the model
rtwdemo_configinterface.

To illustrate how timing information might be listed for a multirate model, here are the Entry-Point
Functions and Inports subsections for the model rtwdemo_mrmtbb. This multirate, discrete-time,
multitasking model contains Inport blocks 1 and 2, which specify 1-second and 2-second sample
times, respectively. The sample times are constrained to the specified times by the Periodic sample
time constraint option on the Solver pane of the Configuration Parameters dialog box.

 Analyze the Generated Code Interface

52-17

matlab:rtwdemo_fcnprotoctrl
matlab:rtwdemo_fcnprotoctrl
matlab:rtwdemo_configinterface
matlab:rtwdemo_mrmtbb


To illustrate how function arguments and return values are displayed in the report, here is the entry-
point function description of the model step function for model rtwdemo_fcnprotoctrl.
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Interpreting the Inports and Outports Subsections
The Inports and Outports subsections of the code interface report provide the following interface
information about each inport and outport in the model.

Field Description
Block Name Displays the Simulink block name of the inport or outport. If you selected

the Code-to-model parameter for your model, you can click on each inport
or outport Block Name value to go to its location in the model display.

Code Identifier Lists the identifier associated with the inport or outport data in the
generated code, as follows:

• If the data is defined in the generated code, the field displays the
identifier text.

• If the data is declared but not defined in the generated code — for
example, if the data is resolved with an imported storage class — the
field displays the identifier text prefixed with the label 'Imported
data:'.

• If the data is neither defined nor declared in the generated code — for
example, if model configuration parameter Code interface packaging
is set to Reusable function — the field displays the text 'Defined
externally'.

Data Type Lists the data type of the inport or outport.
Scaling For fixed-point entries, lists the data type and fraction length using

Simulink fixed-point data type notation.

Note You must have a Fixed-Point Designer license to see fixed-point
scaling information in the report. For more information on how scaling is
represented in the table, see “Fixed-Point Data Type and Scaling Notation”
(Fixed-Point Designer).

Dimension Lists the dimensions of the inport or outport (for example, 1 or [4, 5]).

For example, here are the Inports and Outports subsections for the model
rtwdemo_configinterface.
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Interpreting the Interface Parameters Subsection
The Interface Parameters subsection of the code interface report provides the following interface
information about tunable parameters that are associated with the model.

Field Description
Parameter Source Lists the source of the parameter value, as follows:

• If the source of the parameter value is a block, the field displays the
block name, such as <Root>/Gain2 or <S1>/Lookup1. If you selected
the Code-to-model parameter for your model, you can click the
Parameter Source value to go to the parameter's location in the model
display.

• If the source of the parameter value is a workspace variable, the field
displays the name of the workspace variable.

Code Identifier Lists the identifier associated with the tunable parameter data in the
generated code, as follows:

• If the data is defined in the generated code, the field displays the
identifier text.

• If the data is declared but not defined in the generated code — for
example, if the data is resolved with an imported storage class — the
field displays the identifier text prefixed with the label 'Imported
data:'.

• If the data is neither defined nor declared in the generated code — for
example, if model configuration parameter Code interface packaging
is set to Reusable function — the field displays the text 'Defined
externally'.

Data Type Lists the data type of the tunable parameter.
Scaling For fixed-point entries, lists the data type and fraction length using

Simulink fixed-point data type notation.

Note You must have a Fixed-Point Designer license to see fixed-point
scaling information in the report. For more information on how scaling is
represented in the table, see “Fixed-Point Data Type and Scaling Notation”
(Fixed-Point Designer).

Dimension Lists the dimensions of the tunable parameter (for example, 1 or [4, 5,
6]).

For example, here is the Interface Parameters subsection for the model
rtwdemo_configinterface (with the ExportedGlobal Storage Class button selected in the
model window).
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Interpreting the Data Stores Subsection
The Data Stores subsection of the code interface report provides the following interface information
about global data stores and data stores with non-auto storage that are associated with the model.

Field Description
Data Store Source Lists the source of the data store memory, as follows:

• If the data store is defined using a Data Store Memory block, the field
displays the block name, such as <Root>/DS1. If you selected the
Code-to-model parameter for your model, you can click on the Data
Store Source value to go to the data store's location in the model
display.

• If the data store is defined using a Simulink.Signal object, the field
displays the name of the Simulink.Signal object.

Code Identifier Lists the identifier associated with the data store data in the generated
code, as follows:

• If the data is defined in the generated code, the field displays the
identifier text.

• If the data is declared but not defined in the generated code — for
example, if the data is resolved with an imported storage class — the
field displays the identifier text prefixed with the label 'Imported
data:'.

• If the data is neither defined nor declared in the generated code — for
example, if model configuration parameter Code interface packaging
is set to Reusable function — the field displays the text 'Defined
externally'.

Data Type Lists the data type of the data store.
Scaling For fixed-point entries, lists the data type and fraction length using

Simulink fixed-point data type notation.

Note You must have a Fixed-Point Designer license to see fixed-point
scaling information in the report. For more information on how scaling is
represented in the table, see “Fixed-Point Data Type and Scaling Notation”
(Fixed-Point Designer).

Dimension Lists the dimensions of the data store (for example, 1 or [1, 2]).

For example, here is the Data Stores subsection for the model rtwdemo_configinterface (with
the ExportedGlobal Storage Class button selected in the model window).

Code Interface Report Limitations
The following limitations apply to the code interface section of the HTML code generation reports.

 Analyze the Generated Code Interface

52-21

matlab:rtwdemo_configinterface


• The code interface report does not support the GRT interface with an ERT target or C++ class
code interface packaging. For these configurations, the code interface report is not generated and
does not appear in the HTML code generation report Contents pane.

• The code interface report supports data resolved with most storage classes, except when the
storage class properties are set in any of the following ways:

• The storage class property Type is set to FlatStructure. For example, the BitField and
Struct storage classes in the Simulink package have Type set to FlatStructure.

• The storage class property Type is set to Other. For example, the GetSet storage class in the
Simulink package has Type set to Other.

• The storage class property Data access is set to Pointer, indicating that imported symbols
are declared as pointer variables rather than simple variables. This property is accessible only
when the storage class property Data scope is set to Imported or Instance-specific.

In these cases, the report displays empty Data Type and Dimension fields.
• For outports, the code interface report cannot describe the associated memory (data type and

dimensions) if the memory is optimized. In these cases, the report displays empty Data Type and
Dimension fields.

• The code interface report does not support data type replacement using the Code Generation >
Data Type Replacement pane of the Configuration Parameters dialog box. The data types listed
in the report will link to built-in data types rather than their specified replacement data types.

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment” on page 34-35
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Static Code Metrics
In this section...
“Static Code Metrics” on page 52-23
“Static Code Metrics Analysis” on page 52-23
“View Static Code Metrics and Definitions Within the Generated Code” on page 52-25
“Static Code Metrics Report Limitations” on page 52-26

Static Code Metrics
The code generator performs static analysis on page 52-23 of the generated C or C++ code and
provides these metrics in the Static Code Metrics Report section of the HTML Code Generation
Report. When you place your cursor over a function or a variable in the generated code, you can also
see metrics.

You can use the information in the report to:

• Find the number of files and lines of code in each file.
• Estimate the number of lines of code and stack usage per function.
• Compare the difference in terms of how many files, functions, variables, and lines of code are

generated every time you change the model or MATLAB algorithm.
• Determine a target platform and allocation of RAM to the stack, based on the size of global

variables plus the estimated stack size.
• Determine possible performance slow points, such as the largest global variables or the most

costly call path in terms of stack usage.
• View the cyclomatic complexity of a function, which counts the number of linearly independent

paths through a function.
• View the function call tree. Determine the longest call path to estimate the worst case execution

timing.
• View how target functions, provided by the selected code replacement library, are used in the

generated code.

For examples, see:

• “Generate Static Code Metrics Report for Simulink Model” on page 52-27
• “Generating a Static Code Metrics Report for Code Generated from MATLAB Code” on page 52-

31

Static Code Metrics Analysis
Static analysis of the generated code is performed only on the source code without executing the
program. The results of the static code metrics analysis are included in the Static Code Metrics
section of the HTML Code Generation Report. The report is not available if you generate a MEX
function from MATLAB code.

Static analysis of the generated source code files:
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• Uses the specified C data types. For Simulink models, you specify these data types in the
Hardware Implementation > Production hardware pane of the Configuration Parameters
dialog box. For code generation from MATLAB code, you specify them in the Hardware tab of the
MATLAB Coder project settings dialog box or using a code generation configuration object. Actual
object code metrics might differ due to target-specific compiler and platform settings.

• Includes custom code only if you specify it. For Simulink models, you specify custom code on the
Code Generation > Custom Code pane in the model configuration. For code generation from
MATLAB code, you specify it on the Debugging tab of the MATLAB Coder project settings dialog
box or using a code generation configuration object. An error report is generated if the generated
code includes platform-specific files not contained in the standard C run-time library.

• For Simulink models, includes the generated code from referenced models.
• Uses 1-byte alignment for all members of a structure for estimating global and local data structure

sizes. The size of a structure is calculated by summing the sizes of all of its fields. This estimation
represents the smallest possible size for a structure.

• Calculates the self stack size of a function as the size of local data within a function, excluding
input arguments. The accumulated stack size of a function is the self stack size plus the maximum
of the accumulated stack sizes of its called functions. For example, if the accumulated stacks sizes
for the called functions are represented as accum_size1...accum_sizeN, then the
accumulated stack size for a function is
accumulated_stack_size = self_stack_size + max(accum_size1,...,accum_sizeN)

For example consider this piece of generated code:

Now consider the code metrics shown below:

The accumulated stack size is 12 bytes because the self stack size of the function Debug_b is 12
bytes and the 4 input arguments do not contribute to the calculation of accumulated stack size.

• When estimating the stack size of a function, static analysis stops at the first instance of a
recursive call. The Function Information table indicates when recursion occurs in a function call
path. Code generation generates only recursive code for Stateflow event broadcasting and for
graphical functions if it is written as a recursive function.

• Calculates the cyclomatic complexity of a function as the number of decisions plus one:

CC = Number of decisions + 1

The following constructs add a decision:
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• If statement
• Else-If statement
• Switch statement (1 decision for each case branch)
• Loop statements: While, For, Do-while

Note Boolean operators in the preceding constructs do not add extra decisions.
• Does not include ert_main.c, because you have the option to provide your own main.c.

View Static Code Metrics and Definitions Within the Generated Code
• “Code Generation Report” on page 52-25
• “Code View” on page 52-26

Code Generation Report

When you view code in the code generation report, to access code metrics and definitions:

• On the Code Generation > Report pane, if you select the Static code metrics check box, you
can place your cursor over global variables and functions in the code window to see code metrics
information.

• In the code window, if you click linked variables or functions, the code inspect window opens. The
window provides links to definitions for the variables or functions. On the Code Generation >
Report pane, if you selected the Static code metrics check box, you can also see code metrics
information for the variable or function.
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Code View

When you view code in the Code view of the Code perspective, place your cursor over the ellipsis
menu above global variables and functions to see code metrics information.

The tooltip provides a link to the definition for the variable or function.

Static Code Metrics Report Limitations
Static code metrics are not available if the target configuration for a model results in generated code
that:

• Includes a header file that is not generated by the model hierarchy and is not a system header file
• Uses a macro that is not recognized
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Generate Static Code Metrics Report for Simulink Model
The Static Code Metrics Report is a section included in the HTML Code Generation Report. For
more information on the static analysis of the generated code, see “Static Code Metrics Analysis” on
page 52-23.

1 To generate the static code metrics report in the HTML Code Generation Report, open the
Configuration Parameters dialog box for your model. On the Code Generation > Report pane,
select the “Generate static code metrics” check box. If your model includes referenced models,
select the Generate static code metrics check box in each referenced model’s configuration
set. Otherwise, you cannot view a separate static code metrics report for a referenced model.

Alternatively, after you generate code, generate only the static code metrics report by using the
function coder.report.generateCodeMetrics.

2 Press Ctrl+B to build your model and generate the HTML code generation report. For more
information, see “Generate a Code Generation Report” on page 52-5.

3 If the HTML Code Generation Report is not already open, open the report. On the left navigation
pane, in the Contents section, select Static Code Metrics Report.

If you generated only the static code metrics report, open the report. By default, the static code
metrics report file metrics.html is generated in the current folder.

4 To see the generated files and how many lines of code are generated per file, look at the File
Information section.
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5 Hover your cursor over column titles and some column values to see a description of the
corresponding data.

6 If your model includes referenced models, the File information section includes a Referenced
Model column. In this column, click the referenced model name to open its static code metrics
report. If the static code metrics report is not available for a referenced model, specify the
Generate static code metrics parameter in the referenced model’s configuration set and
rebuild your model.

7 To view the global variables in the generated code, their size, and the number of accesses, see
the Global Variables section.

The Reads/Writes column displays the total number of read and write accesses to the global
variable. The Reads/Writes in a Function column displays the maximum number of read and
write accesses to the global variable within a function. You use this information is to estimate the
benefit of turning on optimizations, which reduce the number of global references. For more
information, see “Optimize Global Variable Usage” on page 71-2.

Click [+] to expand structures.
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8 To navigate from the report to the source code, click a global variable or function name. These
names are hyperlinks to their definitions.

9 To view the function call tree of the generated code, in the Function Information section, click
Call Tree at the top of the table.

ert_main.c is not included in the code metrics analysis, therefore it is not shown in the call tree
format. The Complexity column includes the cyclomatic complexity of each function.

10 To view the functions in a table format, click Table.
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The second column, Called By, lists functions that call the function listed in the first column,
using the following criteria:

• If a function is called by multiple functions, all functions are listed.
• If a function has no called function, this column is empty.

For example, Fueling_Mode is called by Fail and fuel_rate_control_step. The number of
call sites is included in parentheses. Fail calls Fueling_Mode twice.
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Generating a Static Code Metrics Report for Code Generated
from MATLAB Code

The static code metrics report contains the results of static analysis of the generated C/C++ code,
including generated file information, number of lines, and memory usage. For more information, see
“Static Code Metrics” on page 52-23. To produce a static code metrics report, you must use
Embedded Coder to generate standalone C/C++ code and produce a code generation report. See
“Code Generation Reports”.

By default, static code metrics analysis does not run at code generation time. Instead, if and when
you want to run the analysis and view the results, click Code Metrics on the Summary tab of the
code generation report.

Example Static Code Metrics Report
This example runs static code metrics analysis and examines a static code metrics report.

Create the example function averaging_filter.

function y = averaging_filter(x) %#codegen
% Use a persistent variable 'buffer' that represents a sliding window of
% 16 samples at a time.
persistent buffer;
if isempty(buffer)
    buffer = zeros(16,1);
end
y = zeros(size(x), class(x));
for i = 1:numel(x)
    % Scroll the buffer
    buffer(2:end) = buffer(1:end-1);
    % Add a new sample value to the buffer
    buffer(1) = x(i);
    % Compute the current average value of the window and
    % write result
    y(i) = sum(buffer)/numel(buffer);
end

Create sample data.

v = 0:0.00614:2*pi;
x = sin(v) + 0.3*rand(1,numel(v));

Enable production of a code generation report by using a configuration object for standalone code
generation (static library, dynamically linked library, or executable program).

cfg = coder.config('lib', 'ecoder', true);
cfg.GenerateReport=true;

Alternatively, use the codegen -report option.

Generate code by using codegen. Specify the type of the input argument by providing an example
input with the -args option. Specify the configuration object by using the -config option.

codegen averaging_filter -config cfg -args {x}

To open the code generation report, click View report.
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To run the static code metrics analysis and view the code metrics report, on the Summary tab of the
code generation report, click Code Metrics.

Explore the code metrics report.

1 To see the generated files and the number of lines of code per file, click File Information.

2 To see the global variables in the generated code, go to the Global Variables section.

To navigate from the report to the source code, click a global variable name.
3 To view the function call tree of the generated code, in the Function Information section, click

Call Tree.

To navigate from the report to the function code, click a function name.
4 To view the functions in a table format, click Table.
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The second column, Called By, lists functions that call the function listed in the first column. If
multiple functions call that function, all functions are listed. If no functions call that function, this
column is empty.

Requirements for Running Static Code Metrics Analysis After Code
Generation
By default, static code metrics analysis does not run at code generation time. Instead, you can run the
analysis later by clicking Code Metrics in the code generation report. Running static code metrics
analysis after code generation has these requirements and limitations:

• You must have Embedded Coder and use the platform that you used for code generation. Once you
run the static code metrics analysis, you can open the code metrics report without Embedded
Coder or open it on a different platform.

• If you make the code generation report read-only before you run the analysis, each time that you
click Code Metrics, the analysis runs.

Running Static Code Metrics at Code Generation Time
If you want the code generator to run static code metrics analysis and produce the code metrics
report at code generation time:

• In an Embedded Coder code generation configuration object, set GenerateCodeMetricsReport
to true.

• In the MATLAB Coder app, on the Debugging tab, set Static code metrics to Yes.

See Also

More About
• “Code Generation Reports”
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Analyze Code Replacements in Generated Code
When you select the check box Summarize which blocks triggered code replacements for an
ERT-based model, a Code Replacements Report section is automatically included in the generated
HTML report. The Code Replacements Report section documents the code replacement library (CRL)
functions that were used for code replacements during code generation, providing a mapping
between each replacement instance and the Simulink block that triggered the replacement. To enable
display of the Simulink block information, select the Code Generation > Comments check box
Include comments. On the same pane, select either the Simulink block comments checkbox or
the Simulink block descriptions check box if present, or both.

You can use the report to:

• Determine which replacement functions were used in the generated code.
• Trace each replacement instance back to the block that triggered the replacement.

The figure below shows a Code Replacements Report generated for the CRL model
rtwdemo_crladdsub. Each replacement function used is listed with a link to the block that
triggered the replacement.
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If you click a block path in the report, the block that triggered the replacement is highlighted in the
model diagram. If the replacement was triggered by a Stateflow chart or a MATLAB function, a
window opens to display the chart or function.

For more information, see “Verify Code Replacement Library” on page 67-55.
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Document Generated Code with Simulink Report Generator
In this section...
“Generate Code for the Model” on page 52-36
“Open the Report Generator” on page 52-37
“Set Report Name, Location, and Format” on page 52-39
“Include Models and Subsystems in a Report” on page 52-40
“Customize the Report” on page 52-40
“Generate the Report” on page 52-41

The Simulink Report Generator software creates documentation from your model in multiple formats,
including HTML, PDF, RTF, Microsoft Word, and XML. This example shows one way to document a
code generation project in Microsoft Word. The generated report includes:

• System snapshots (model and subsystem diagrams)
• Block execution order list
• Simulink Coder and model version information for generated code
• List of generated files
• Optimization configuration parameter settings
• System target file selection and build process configuration parameter settings
• Subsystem map
• File name, path, and generated code listings for the source code

To adjust Simulink Report Generator settings to include custom code and then generate a report for a
model, complete the following tasks:

1 “Generate Code for the Model” on page 52-36
2 “Open the Report Generator” on page 52-37
3 “Set Report Name, Location, and Format” on page 52-39
4 “Include Models and Subsystems in a Report” on page 52-40
5 “Customize the Report” on page 52-40
6 “Generate the Report” on page 52-41

A Simulink Report Generator license is required for the following report formats: PDF, RTF, Microsoft
Word, and XML. For more information on generating reports in these formats, see the Simulink
Report Generator documentation.

Generate Code for the Model
Before you use the Report Generator to document your project, generate code for the model.

1 In the MATLAB Current Folder browser, navigate to a folder where you have write access.
2 Create a working folder from the MATLAB command line by typing:

mkdir report_ex
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3 Make report_ex your working folder:

cd report_ex
4 Open the slexAircraftExample model by entering the model name on the MATLAB command

line.
5 On the Simulation tab, in the Save list, select Save as. Navigate to the working folder,

report_ex, and save a copy of the slexAircraftExample model as myModel.
6 Open the Configuration Parameters dialog box. Set the Solver > Solver selection > Type

parameter to Fixed-step.
7 Select the Code Generation pane. Select Generate code only.
8 Click Apply.
9 In the model window, press Ctrl+B. The build process generates code for the model.

Open the Report Generator
After you generate the code, open the Report Generator.

1 Open the Report Generator app. In the model diagram window, in the Apps gallery, click Report
Generator.

2 In the Report Explorer window, in the options pane (center), click the folder rtw (\toolbox\rtw).
Click the setup file that it contains, codegen.rpt.
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3 Double-click codegen.rpt or select it and click the Open report button. The Report Explorer
displays the structure of the setup file in the outline pane (left).
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Set Report Name, Location, and Format
Before generating a report, you can specify report output options, such as the folder, file name, and
format. For example, to generate a Microsoft Word report named MyCGModelReport.rtf:

1 In the properties pane, under Report Options, review the options listed.
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2 Leave the Directory field set to Present working directory.
3 For Filename, select Custom: and replace index with the name MyModelCGReport.
4 For File format, specify Rich Text Format and replace Standard Print with Numbered

Chapters & Sections.

Include Models and Subsystems in a Report
Specify the models and subsystems that you want to include in the generated report by setting
options in the Model Loop component.

1 In the outline pane (left), select Model Loop. Report Generator displays Model Loop component
options in the properties pane.

2 If not already selected, select Current block diagram for the Model name option.
3 In the outline pane, click Report - codegen.rpt*.

Customize the Report
After specifying the models and subsystems to include in the report, you can customize the sections
included in the report.

1 In the outline pane (left), expand the node Chapter - Generated Code. By default, the report
includes two sections, each containing one of two report components.

2 Expand the node Section 1 — Code Generation Summary.
3 Select Code Generation Summary. Options for the component are displayed in the properties

pane.
4 Click Help to review the report customizations that you can make with the Code Generation

Summary component. For this example, do not customize the component.
5 In the Report Explorer window, expand the node Section 1 — Generated Code Listing.
6 Select Import Generated Code. Options for the component are displayed in the properties

pane.
7 Click Help to review the report customizations that you can make with the Import Generated

Code component.
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Generate the Report
After you adjust the report options, from the Report Explorer window, generate the report by
clicking File > Report. A Message List dialog box opens, which displays messages that you can
monitor as the report is generated. Model snapshots also appear during report generation. The
Message List dialog box might be hidden behind other dialog boxes.

When the report is complete, open the report, MyModelCGReport.rtf in the folder report_ex (in
this example).
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Get Code Description of Generated Code
You can use the code descriptor API to obtain meta-information about the generated code. For each
model build, the code generator, by default, creates a codedescriptor.dmr file in the build folder.
When simulating the model in Accelerator and Rapid Accelerator modes, the codedescriptor.dmr
is not generated.

You can use the code descriptor API once the code is generated. Use the code descriptor API to
describe these items in the generated code:

• Data Interfaces: inports, outports, parameters, data stores, and internal data.
• Function Interfaces: initialize, output, update, and terminate.
• Run-time information of the data and function interfaces, such as timing requirements of each

interface entity.
• Model hierarchy information and code description of referenced models.

Get Data Interface Information

The coder.descriptor.DataInterface object describes various properties for a specified data
interface in the generated code. In the model rtwdemo_comments, there are four inports, one
outport, and a tunable external parameter. For more information about the data interfaces in your
model, use the coder.codedescriptor.CodeDescriptor object and its methods.

1. Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

2. Open and build the model.

open_system('rtwdemo_comments');
evalc('slbuild(''rtwdemo_comments'')');
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3. Create a coder.codedescriptor.CodeDescriptor object for the required model by using the
getCodeDescriptor function.

codeDescriptor = coder.getCodeDescriptor('rtwdemo_comments');

4. To obtain a list of all the data interface types in the generated code, use the
getDataInterfaceTypes method.

dataInterfaceTypes = codeDescriptor.getDataInterfaceTypes()

dataInterfaceTypes =

  5x1 cell array

    {'Inports'                 }
    {'Outports'                }
    {'Parameters'              }
    {'ExternalParameterObjects'}
    {'InternalData'            }

To obtain a list of all the supported data interfaces, use the getAllDataInterfaceTypes method.

5. To obtain more information about a particular data interface type, use the getDataInterfaces
method.

dataInterface = codeDescriptor.getDataInterfaces('Inports');
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This method returns properties of the Inport blocks in the generated code.

6. Because this model has four inports, dataInterface is an array of
coder.descriptor.DataInterface objects. Obtain the details of the first Inport of the model by
accessing the first location in the array.

dataInterface(1)

ans = 

  DataInterface with properties:
              Type: [1x1 coder.descriptor.types.Type]
               SID: 'rtwdemo_comments:99'
     GraphicalName: 'In1'
       VariantInfo: [1x0 coder.descriptor.VariantInfo]
    Implementation: [1x1 coder.descriptor.DataImplementation]
            Timing: [1x1 coder.descriptor.TimingInterface]
              Unit: ''
             Range: [1x0 coder.descriptor.Range]

Get Function Interface Information

The function interfaces are the entry-point functions in the generated code. In the model
rtwdemo_roll, the entry-point functions are model_initialize, model_step, and
model_terminate. For more information about the function interfaces in your model, use the
coder.descriptor.FunctionInterface object.

1. Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

2. Open and build the model.

open_system('rtwdemo_roll');
evalc('slbuild(''rtwdemo_roll'')');
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3. Create a coder.codedescriptor.CodeDescriptor object for the required model by using the
getCodeDescriptor function.

codeDescriptor = coder.getCodeDescriptor('rtwdemo_roll');

4. To obtain a list of all the function interface types in the generated code, use the
getFunctionInterfaceTypes method.

functionInterfaceTypes = codeDescriptor.getFunctionInterfaceTypes()

functionInterfaceTypes =

  2x1 cell array

    {'Initialize'}
    {'Output'    }

To obtain a list of all the supported function interfaces, use the getAllFunctionInterfaceTypes
method.

5. To obtain more information about a particular function interface type, use the
getFunctionInterfaces method.

functionInterface = codeDescriptor.getFunctionInterfaces('Initialize')

functionInterface = 

  FunctionInterface with properties:
        Prototype: [1x1 coder.descriptor.types.Prototype]
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     ActualReturn: [1x0 coder.descriptor.DataInterface]
      VariantInfo: [1x0 coder.descriptor.VariantInfo]
    FunctionOwner: [1x0 coder.descriptor.TypedRegion]
           Timing: [1x1 coder.descriptor.TimingInterface]
       ActualArgs: [1x0 coder.descriptor.DataInterface Sequence]

6. You can further expand on the properties to obtain detailed information. To get the function return
value, name, and arguments:

functionInterface.Prototype

ans = 

  Prototype with properties:
          Name: 'rtwdemo_roll_initialize'
        Return: [1x0 coder.descriptor.types.Argument]
    HeaderFile: 'rtwdemo_roll.h'
    SourceFile: 'rtwdemo_roll.c'
     Arguments: [1x0 coder.descriptor.types.Argument Sequence]

Get Model Hierarchy Information

Use the coder.codedescriptor.CodeDescriptor object to get the entire model hierarchy
information. The model rtwdemo_async_mdlreftop has model rtwdemo_async_mdlrefbot as
the referenced model.

1. Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

2. Open and build the model.

open_system('rtwdemo_async_mdlreftop');
evalc('slbuild(''rtwdemo_async_mdlreftop'')');
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3. Create a coder.codedescriptor.CodeDescriptor object for the required model by using the
getCodeDescriptor function.

codeDescriptor = coder.getCodeDescriptor('rtwdemo_async_mdlreftop');

4. Get a list of all the referenced models by using the getReferencedModelNames method.

refModels = codeDescriptor.getReferencedModelNames()

refModels =

  1x1 cell array

    {'rtwdemo_async_mdlrefbot'}

5. To obtain the coder.codedescriptor.CodeDescriptor object for the referenced model, use
the getReferencedModelCodeDescriptor method.

refCodeDescriptor = codeDescriptor.getReferencedModelCodeDescriptor('rtwdemo_async_mdlrefbot');
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You can now use the refCodeDescriptor object to obtain more information about the referenced
model by using all the available methods in the Code Descriptor API.

See Also

Related Examples
• “Analyze the Generated Code Interface” on page 52-13
• coder.codedescriptor.CodeDescriptor
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Customize Code Comments to Enhance Readability and
Traceability

This example shows how to add comments to numerous types of objects in Simulink® and
Stateflow®.

model='rtwdemo_comments';
open_system(model)

% Cleanup
rtwdemoclean;
close_system(model,0)

See Also

More About
• “Model Configuration Parameters: Comments”

53 Code Appearance in Embedded Coder

53-2



Add Custom Comments for Variables in the Generated Code
To control code generation options for signals, states, and parameters in a model, you can create data
objects in a workspace or data dictionary. You can generate comments in the code that help you to
document the purpose and properties of the data in each object. Associate handwritten comments
with each object, or write a function that generates comments based on the properties of the object.

For more information about data objects, see “Data Objects”.

Embed Handwritten Comments for Signals or Parameters
To embed handwritten comments in the generated code near the definition of a signal, state, or
parameter:

1 Open a Simulink model.

openExample('ex_param_array)';

2 Create a data object to represent a signal, state, or parameter. You can use a data object from
any package such as Simulink. For example, use a data object of the classes Simulink.Signal
or Simulink.Parameter, which are defined in the package Simulink.

myParam = Simulink.Parameter(15.23);
3 In the model, under the PREPARE section select Property Inspector. Click the target Gain

block. Set its parameter value to myParam.
4 Set the storage class of the data object so that optimizations do not eliminate the signal or

parameter from the generated code. For example, use the storage class ExportedGlobal.

myParam.StorageClass = 'ExportedGlobal';
5 Set the Description property of the object. The description that you specify appears in the

generated code as lines of comments.

myParam.Description = 'This parameter represents multiplication';

6 In the Model Configuration Parameters select Simulink data object descriptions.
7 Generate code from the model. In the code, the data object description appears near the

definition of the corresponding variable.

/* Exported block parameters */
real_T myParam = 15.23;     /* Variable: myParam
                             * Referenced by: '<S1>/Gain'
                             * This parameter represents multiplication.
                             */

Generate Dynamic Comments Based on Data Properties
You can generate dynamic comments that include the properties of a data object such as data type,
units, and dimensions. If you change the properties of the data object in Simulink, the code generator
maintains the accuracy of the comments. For example, this comment displays some of the property
values for a data object named MAP for the Simulink model in the previous example:
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1 Create a data object from the package mpt and apply a custom storage class to the object. The
default storage class is the custom storage class Global (Custom).

myParam = mpt.Parameter;

To generate dynamic comments, you must use a data object from the package mpt and you must
apply a custom storage class to the object.

2 Write a MATLAB or TLC function that generates the comment text. For an example MATLAB
function, see the function matlabroot/toolbox/rtw/rtwdemos/
rtwdemo_comments_mptfun.m.

The function must accept three input arguments that correspond to objectName, modelName,
and request. If you write a TLC file, you can use the library function
LibGetSLDataObjectInfo to get the property values of the data object.

3 Save the function as a MATLAB file or a TLC file. Place the file in a folder that is on your MATLAB
path.

4 In the Model Configuration Parameters select Custom comments (MPT objects only).
5 Set Custom comments function to the name of the MATLAB file or TLC file that you created.
6 Generate code from the model. The comments that your function generates appear near the code

that represents each data object.

/* Object: myParam - user description:
   DataType -- auto
   Units    --
   CSC      -- Global */

Limitations

• To generate comments by using the Custom comments (MPT objects only) and Custom
comments function options, you must create data objects from the package mpt. The data
objects must use a custom storage class.

• Only the custom storage classes from the mpt package that create unstructured variables support
the custom comments function.

See Also

More About
• “Organize Parameter Data into a Structure by Using Struct Storage Class” on page 33-68
• “Model Configuration Parameters: Comments”
• “Data Objects”
• “MPT Data Object Properties” on page 37-2
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Add Global Comments in the Generated Code
In this section...
“Use a Simulink DocBlock to Add a Comment” on page 53-5
“Use a Simulink Annotation to Add a Comment” on page 53-7
“Use Sorted Notes to Add Comments” on page 53-8
“Limitations” on page 53-9

These examples show how to add a global comment to a Simulink model so that the comment text
appears in the generated file or files. Specify a template symbol name with a Simulink DocBlock, a
Simulink annotation, or a Stateflow note. You can also use a sorted-notes capability that works with
Simulink annotations or Stateflow notes, but not DocBlocks. For more information about template
symbols, see “Template Symbols and Rules” on page 53-77.

Note Template symbol names Description and Model Information are fields in the Property
Inspector dialog box. If you use one of these symbol names for global comment text and its Property
Inspector fields also has text in it, both names appear in the generated files.

Use a Simulink DocBlock to Add a Comment
1 Open a Simulink model.

model='rtwdemo_codetemplate';
open_system(model)

2 Under Configuration Parameters, set the Code templates to rtwdemocodetemplate.cgt. This
code template contains the required customizations to generate global comments.

3 Right-click the DocBlock and select Mask > Mask Parameters.
4 In the Code generation template symbol box, type one of the following:

• Abstract
• Description
• History
• Notes
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Click OK. Template symbol names are case-sensitive.

If you are using a DocBlock to add comments to your code, set the Document type to Text. If
you set Document type to RTF or HTML, your comments do not appear in the code.

5 In the Block Properties dialog box, on the Block Annotation tab, select %<ECoderFlag> and
click OK. The symbol name that you typed in the previous step now appears under the DocBlock
in the model.
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6 Save the model. After you generate code, the code generator places the comment in each
generated file whose template has the symbol name that you designated. The code generator
places the comment in the generated file at the location that corresponds to where the symbol
name is located in the template file.

The relevant fragment from the generated file for this model is:

     *
     * ABSTRACT:
     * This text maps to the code template %<Abstract> symbol.

7 To add more comments to the generated files, repeat steps 2–6.

Use a Simulink Annotation to Add a Comment
1 Open the model rtwdemo_codetemplate.
2 Double-click the unoccupied area on the model where you want to place the comment. See

“Describe Models Using Notes and Annotations”.
3 Type <S:Symbol_name> followed by the comment. Symbol_name is one of the following:
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• Abstract
• Description
• History
• Notes

For example, type <S:Description>This is the description I want. Template symbol
names are case-sensitive. If you want the code generator to sort multiple comments for the
Notes symbol name, replace the next step with “Use Sorted Notes to Add Comments” on page
53-8.

4 Click outside the annotation rectangle and save the model. After you generate code, the code
generator places the comment in each generated file whose template has the symbol name that
you assigned. The code generator places the comment in the generated file at the location that
corresponds to where the symbol name is located in the template file. If you want the code
generator to sort multiple comments for the Notes symbol name, replace the next step with “Use
Sorted Notes to Add Comments” on page 53-8.

5 To add one or more other comments to the generated files, repeat steps 2–4.

Use Sorted Notes to Add Comments
The sorted-notes capability enables you to add sorted comments to the generated files. The code
generator places these comments in each generated file at the location that corresponds to where the
Notes symbol is located in the template file.

The code generator uses this sorting order:

• Numbers before letters.
• Among numbers, zero is placed first.
• Among letters, uppercase letters are placed before lowercase letters.

You can use sorted notes for a Simulink annotation or a Stateflow note, but not with a DocBlock.

• In the Simulink annotation or the Stateflow note, type <S:NoteY> followed by the first comment.
Y is a number or a letter.

• Repeat this process for as many additional comments you want. Replace Y with a subsequent
number or letter.

This figure illustrates sorted notes on a model. It shows where the code generator places each note in
a generated file.
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The relevant fragment from the generated file for this model is:
     *
     * NOTES:
     * Note: This Simulink annotation maps to the code template %<Note> symbol.
     * Note1: Another Simulink annotation .
     *

Limitations
You cannot generate global comments using template symbol names inside a Simulink DocBlock,
when the Language for code generation is C++.

See Also

More About
• “Model Configuration Parameters: Comments”
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Customize Generated Identifier Naming Rules
In this section...
“Apply Naming Rules to Identifiers Globally” on page 53-10
“Apply Naming Rules to Simulink Data Objects” on page 53-11

For GRT and RSim targets, the code generator constructs identifiers for variables and functions in the
generated code. For ERT targets, you can customize the naming of identifiers in the generated code
by specifying parameters on the Code Generation > Identifiers pane in the Configuration
Parameters dialog box. You can also specify parameters that control identifiers generated from
Simulink data objects. For detailed information about these parameters, see “Model Configuration
Parameters: Code Generation Identifiers”.

Apply Naming Rules to Identifiers Globally
Goal Specify
Set the maximum number of characters that the code
generator uses for function, typedef, and variable
names (default 31).

An integer value for the “Maximum identifier length”
parameter. For more information, see “Specify
Identifier Length to Avoid Naming Collisions”. If you
expect your model to generate lengthy identifiers (due
to use of long signal or parameter names, for
example), or if identifiers are mangled more than you
expect, increase the value of this parameter.

Define a macro that specifies certain text included
within generated identifiers for:

• Global variables
• Global types
• Field names of global types
• Subsystem methods
• Subsystem method arguments
• Local temporary variables
• Local block output variables
• Constant macros
• Shared utilities identifier format

A macro for the Identifier format control
parameters. For more information, see “Identifier
Format Control” on page 53-15. See also “Exceptions
to Identifier Formatting Conventions” on page 53-24
and “Identifier Format Control Parameters
Limitations” on page 53-25.

Set the minimum number of characters that the code
generator uses for the mangling text.

An integer value for the “Minimum mangle length”
parameter. For more information, see “Control Name
Mangling in Generated Identifiers” on page 53-21
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Goal Specify
Control whether the software uses shortened names
for system-generated identifiers.

Shortened for the “System-generated identifiers”
parameter. This setting:

• Provides more space for user names.
• Provides a more predictable and consistent naming

system that uses camel case.
• Does not include underscores or plurals.
• Provides consistent abbreviations for both a type

and a variable.
Control whether the generated code expresses scalar
inlined parameter values as literal values or as macros.

The value Literals or Macros for the “Generate
scalar inlined parameters as” parameter.

• Literals: If you set Default parameter
behavior to Inlined, parameters are expressed as
numeric constants.

• Macros: Parameters are expressed as variables
(with #define macros). This setting makes code
more readable.

Apply Naming Rules to Simulink Data Objects
When your model uses Simulink data objects from the Simulink package, identifiers in generated
code copy the names of the objects by default. For example, a Simulink.Signal object named
Speed appears as the identifier Speed in generated code.

You can control these identifiers by specifying naming rules that are specific to Simulink data objects.
On the Code Generation > Identifiers pane of the Configuration Parameters dialog box, adjust the
settings in the Simulink data object naming rules section.

When you specify naming rules for generated code, follow ANSI C6/C++ rules for naming identifiers.

Specify Naming Rule Using a Function

This example shows how to customize identifiers in generated code by defining a MATLAB function.

1 Write a MATLAB function that returns an identifier by modifying a data object name, and save
the function in your working folder. For example, the following function returns an identifier
name by appending the text _param to a data object name.

function revisedName = append_text(name, object)
% APPEND_TEXT: Returns an identifier for generated
% code by appending text to a data object name.
%
% Input arguments:
% name: data object name as spelled in model
% object: target data object
%
% Output arguments:
% revisedName: altered identifier returned for use in

6. ANSI is a registered trademark of the American National Standards Institute, Inc.
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% generated code.
%
%
text = '_param';

revisedName = [name,text];
2 Open the model rtwdemo_namerules.
3 Double-click the yellow box labeled View Symbols Configuration to open the Code

Generation > Identifiers pane in the Configuration Parameters dialog box.
4 From the “Parameter naming” drop-down list, select Custom M-function.

5 In the M-function field, type the name of the file that defines the MATLAB function,
append_text.m.

6 Click Apply.
7 Generate code for the model.
8 Inspect the code generation report to confirm the parameter object naming rule. For example,

the generated file rtwdemo_namerules.h represents the parameter objects G1, G2, and G3 with
the variables G1_param, G2_param, and G3_param.

Specify Naming Rule for Storage Class Define

You can specify a naming rule that applies only to Simulink data objects whose storage class you set
to Define. For these data objects, the specified naming rule overrides the other parameter and
signal object naming rules. On the Code Generation > Identifiers pane in the Configuration
Parameters dialog box, adjust the “#define naming” setting.

Override Data Object Naming Rules

This example shows how to override a data object naming rule for a single data object.

You can override data object naming rules by specifying the Identifier property of an individual
Simulink data object. Generated code uses the text that you specify as the identifier to represent the
data object, regardless of naming rules.

1 Open the model rtwdemo_namerules.
2 On the Modeling tab, click Model Data Editor.
3 In the Model Data Editor, on the Parameters tab, click the Show/refresh additional

information button.
4 In the data table, find the row that corresponds to the Simulink.Parameter object G1, which

resides in the base workspace.
5

In the row, double-click the parameter icon .
6 In the Model Explorer Dialog pane (the right pane), for G1, specify the Identifier property as

mySpecialParam. Click Apply.
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7 Generate code for the model.
8 In the code generation report, confirm the identifier for the parameter object G1. The generated

file rtwdemo_namerules.h represents G1 with the variable mySpecialParam.

Apply Custom Naming Conventions to Identifiers

This example shows how to apply uniform naming rules for Simulink® data objects, including signals,
parameters, and data store memory variables.

model='rtwdemo_namerules';
open_system(model)
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% Cleanup
rtwdemoclean;
close_system(model,0)

See Also
“Signal naming”
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Identifier Format Control
You can customize generated identifiers by specifying the Identifier format control parameters on
the Code Generation > Identifiers pane in the Configuration Parameters dialog box. For each
parameter, you can enter a macro that specifies whether, and in what order, certain text is included
within generated identifiers. For example, you can specify that the root model name be inserted into
each identifier using the $R token.

The macro can include:

• Valid tokens, which are listed in Identifier Format Tokens. You can use or omit tokens depending
on what you want to include in the identifier name. The Shared utilities identifier format
parameter requires you to specify the checksum token, $C. The other parameters require the
mangling token, $M. For more information, see “Control Name Mangling in Generated Identifiers”
on page 53-21. The mangling token is subject to the use and ordering restrictions noted in
Identifier Format Control Parameter Values.

• Token decorators, which are listed in “Control Case with Token Decorators” on page 53-18. You
can use token decorators to control the case of generated identifiers for each token.

• Valid C or C++ language identifier characters (a-z, A-Z, _ , 0-9).

The build process generates each identifier by expanding tokens and inserting the resultant text into
the identifier. The tokens are expanded in the order listed in Identifier Format Tokens. Groups of
characters are inserted in the positions that you specify around tokens directly into the identifier.
Contiguous token expansions are separated by the underscore (_) character.
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Identifier Format Tokens

Token Description
$C This token is required for Shared utilities identifier format. If the identifier

exceeds the Maximum identifier length, the code generator inserts an 8-character
checksum to avoid naming collisions. The position of the $C token in the Identifier
format control parameter specification determines the position of the checksum in
the generated identifier. For example, if you use the specification $N$C, the
checksum is appended to the end of the identifier. This token is available only for
shared utilities.

$M This token is required. If necessary, the code generator inserts name-mangling text to
avoid naming collisions. Modify checksum character length by using Shared
checksum length parameter. The position of the $M token in the Identifier format
control parameter specification determines the position of the name-mangling text
in the generated identifier. For example, if you use the specification $R$N$M, the
name-mangling text is appended (if required) to the end of the identifier. For more
information, see “Control Name Mangling in Generated Identifiers” on page 53-21.

$U Insert text that you specify for the $U token. Use the Custom token text parameter
to specify this text.

$F Insert method name (for example, _Update for update method). This token is
available only for subsystem methods.

$N Insert name of object (block, signal or signal object, state, parameter, shared utility
function or parameter object) for which identifier is being generated.

$R Insert root model name into identifier, replacing unsupported characters with the
underscore (_) character. When you use referenced models, this token is required in
addition to $M (see “Avoid Identifier Name Collisions with Referenced Models” on
page 53-22).

Note: This token replaces the Prefix model name to global identifiers option in
previous releases.

$H Insert tag indicating system hierarchy level. For root-level blocks, the tag is the text
root_. For blocks at the subsystem level, the tag is of the form sN_. N is a unique
system number assigned by the Simulink software. This token is available only for
subsystem methods and field names of global types.

Note: This token replaces the Include System Hierarchy Number in Identifiers
option in previous releases.

$A Insert data type acronym (for example, i32 for integers) to signal and work vector
identifiers. This token is available for local block output variables, local temporary
variables, and field names of global types.

Note: This token replaces the Include data type acronym in identifier option in
previous releases.
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Token Description
$I • Insert u if the argument is an input.

• Insert y if the argument is an output.
• Insert uy if the argument is an input and output.

For example, rtu_ for an input argument, rty_ for an output argument, and rtuy_
for an input and output argument. This token is available only for subsystem method
arguments.

$G Insert the name of a storage class that is associated with the data item. This token is
also available in the naming rule that you specify for the Header File for a storage
class in the Embedded Coder Dictionary.

$E Insert the file type. $E represents these instances of file types:

• capi
• capi_host
• dt
• testinterface
• private
• types

This token is required for Header files and Source files.

Identifier Format Control Parameter Values lists the default macro value, the supported tokens, and
the applicable restrictions for each Identifier format control parameter.
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Identifier Format Control Parameter Values

Parameter Default
Value

Supported
Tokens

Restrictions

Global variables $R$N$M $M, $R,
$G,$N,$U

$F, $H, $A, $E, and $I are not allowed.

Global types $N$R$M_T $M, $R,
$G,$N,$U

$F, $H, $A, $E, and $I are not allowed.

Field name of global
types

$N$M $M, $N, $H, $A,
$U

$R, $F, $G, $E, and $I are not allowed.

Subsystem methods $R$N$M$F $M, $R, $N, $H,
$F, $U

$F and $H are empty for Stateflow
functions; $A, $G, $E, and $I are not
allowed.

Subsystem method
arguments

rt$I$N$M $M, $N, $I, $U $R, $F, $H, $G, $E, and $A are not
allowed.

Local temporary
variables

$N$M $M, $R, $N, $A,
$U

$F, $H, $G, $E, and $I are not allowed.

Local block output
variables

rtb_$N$M $M, $N, $A, $U $R, $F, $H, $G, $E, and $I are not
allowed.

Constant macros $R$N$M $M, $R, $N, $U $F, $H, $A, $G, $E, and $I are not
allowed.

Shared utilities
identifier format

$N$C $N, $C, $R, $U $C is required. $M, $F, $H, $A, $G, $E,
and $I are not allowed.

EMX array utility
functions identifier
format

emx$M$N $M, $N,$R $C, $U, $F, $H, $A, $G, $E, and $I are not
allowed.

EMX array types
identifier format

emxArray_
$M$N

$M, $N,$R $C, $U, $F, $H, $A, $G, $E, and $I are not
allowed.

Header files $R$E $R,$U,$E $C, $M, $N, $F, $H, $A, $G, and $I are not
allowed.

Source files $R$E $R,$U,$E $C, $M, $N, $F, $H, $A, $G, and $I are not
allowed.

Data files $R_data $R,$U $C, $M, $N, $F, $H, $A, $G, $E, and $I are
not allowed.

Non-ERT-based targets (such as the GRT target) implicitly use a default $R$N$M specification. This
default specification consists of the root model name, followed by the name of the generating object
(signal, parameter, state, and so on), followed by name-mangling text.

For limitations that apply to Identifier format control parameters, see “Exceptions to Identifier
Formatting Conventions” on page 53-24 and “Identifier Format Control Parameters Limitations” on
page 53-25.

Control Case with Token Decorators
On the Code Generation > Identifiers pane, you can use token decorators to control the case of
generated identifiers. Place a decorator immediately after the target token and enclose the decorator
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in square brackets [ ]. For example, you can set Global variables to $R[uL]$N$M, which
capitalizes the first letter of the model name and forces the remaining characters in the model name
to lowercase.

The table shows how to manipulate the expansion of the $R token for a model whose name is
modelName.

Desired
Expansion

Description Token and Decorator

ModelName First letter of model name is uppercase.
Remaining characters are not modified.

$R[u]

Modelname First letter of model name is uppercase.
Remaining characters are lowercase.

$R[uL]

MODELNAME All characters are uppercase. $R[U]
modelname All characters are lowercase. $R[L]
mODELNAME First letter of model name is lowercase.

Remaining characters are uppercase.
$R[lU]

modelName First letter of model name is lowercase.
Remaining characters are not modified.

$R[l]

When you use a decorator, the code generator removes the underscore character (_) that appears
between tokens by default. However, you can append each decorator with an underscore: $R[U_]$N.
For example, if you set the Global variables parameter to $R[u_]$N[uL]$M for a model named
modelName and a DWork structure represented by DW, the result is ModelName_Dw.

Control Formatting of Identifiers
This example shows how you can customize generated identifiers by specifying the Identifier format
control parameters on the Code Generation > Identifiers pane in the Configuration Parameters
dialog box. To maintain model traceability, it is important that incremental revisions to a model have
minimal impact on the identifier names that appear in the generated code. This example shows how
you can use name mangling by specifying the Identifier format control parameters to minimally
impact the identifier names.

model='rtwdemo_symbols';
open_system(model)
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% Cleanup
rtwdemoclean;
close_system(model,0)
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Control Name Mangling in Generated Identifiers
The position of the $M token in the Identifier format control parameter specification determines
the position of the name-mangling text in the generated identifiers. For example, if you use the
specification $R$N$M, the name-mangling text is appended (if required) to the end of the identifier.
For more information, see “Identifier Format Control” on page 53-15.

Name-Mangling Text Per Object

Object Type Source of Mangling Text
Block diagram Name of block diagram
Simulink block Simulink identifier (for details, see “Simulink Identifiers”)
Simulink parameter Full name of parameter owner (model or block) and parameter name
Simulink signal Signal name, full name of source block, and port number
Stateflow objects Complete path to Stateflow block and Stateflow computed name (unique

within chart)

The length of the name-mangling text is specified by the “Minimum mangle length” parameter. The
default value is 1, but this automatically increases during code generation as a function of the
number of collisions. To minimize disturbance to the generated code during development, specify a
larger Minimum mangle length. A Minimum mangle length of 4 is a conservative value. A value
of 4 allows for over 1.5 million collisions for a particular identifier before the mangle length is
increased.

Minimize Name Mangling
The length of generated identifiers is limited by the Maximum identifier length parameter. When a
name collision exists, the $M token is expanded to the minimum number of characters required to
avoid the collision. Other tokens are expanded in the order listed in Identifier Format Tokens. If the
Maximum identifier length is not large enough to accommodate full expansions of the other
tokens, partial expansions are used. To avoid partial expansions, it is good practice to:

• Avoid name collisions. One way to avoid name collisions is to not use default block names (for
example, Gain1, Gain2...) when there are many blocks of the same type in the model.

• Where possible, increase the Maximum identifier length to accommodate the length of the
identifiers that you expect to generate.

• Set the Maximum identifier length parameter to reserve at least three characters for the name-
mangling text. The length of the name-mangling text increases as the number of name collisions
increases.

If changes to the model create more or fewer collisions, existing name-mangling text increases or
decreases in length. If the length of the name-mangling text increases, additional characters are
appended to the existing text. For example, the mangling text 'xyz' can change to 'xyzQ'. For
fewer collisions, the name-mangling text 'xyz' changes to 'xy'.
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Avoid Identifier Name Collisions with Referenced Models
Within a model that uses referenced models, collisions between the names of the models are not
allowed. When generating code from a model that uses model referencing:

• You must include the $R token in the Identifier format control parameter specifications (in
addition to the $M token).

• The Maximum identifier length must be large enough to accommodate full expansions of the $R
and $M tokens. If Maximum identifier length is too small, a code generation error occurs.

When a name conflict occurs between an identifier within the scope of a higher-level model and an
identifier within the scope of a referenced model, the identifier from the referenced model is
preserved. Name mangling is performed on the identifier from the higher-level model.

If your model contains two referenced models with the same input or output port names, and one of
the referenced models contains an atomic subsystem with “Function packaging” set to
Nonreuseable function, a name conflict can occur and the build process produces an error.

Use Model Advisor to Detect Identifier Names Changed During Code
Generation
For a referenced model, if the following parameters on have specifications that do not contain a $R
token (which represents the name of the reference model), code generation prepends the $R token to
the identifier format.

• “Global variables”
• “Global types”
• “Subsystem methods”
• “Constant macros”

You can use the Model Advisor to identify referenced models in a model referencing hierarchy for
which code generation changes these configuration parameter settings.

1 In the Modeling tab, click Model Advisor.
2 Select By Task.
3 Run the Check code generation identifier formats used for model reference check.

See Also

Related Examples
• “Identifier Format Control” on page 53-15
• “Specify Identifier Length to Avoid Naming Collisions” on page 46-29

53 Code Appearance in Embedded Coder

53-22



Maintain Traceability for Generated Identifiers
To verify your model, you can trace back and forth between generated identifiers and corresponding
entities within the model. To maintain traceability, it is important that incremental revisions to a
model have minimal impact on the identifier names that appear in generated code. There are two
ways to minimally impact the identifier names:

• Choose unique names for Simulink objects (blocks, signals, states, and so on) as much as possible.
• Use name mangling when conflicts cannot be avoided.

The position of the name-mangling text is specified by the placement of the $M token in the Identifier
format control parameters. Mangle characters consist of alphanumeric characters that are unique
to each object. For more information, see “Control Name Mangling in Generated Identifiers” on page
53-21.
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Exceptions to Identifier Formatting Conventions
There are some exceptions to the identifier formatting conventions described in “Identifier Format
Control” on page 53-15.

• Type name generation: name mangling conventions do not apply to type names (that is, typedef
statements) generated for global data types. If the $R token is included in the Identifier format
control parameter specification, the model name is included in the typedef. When generating
type definitions, the Maximum identifier length parameter is not respected.

• Non-Auto storage classes: the Identifier format control parameters specification does not affect
objects (such as signals and parameters) that have a storage class other than Auto (such as
ImportedExtern or ExportedGlobal).

• For shared utilities, code generation inserts the checksum specified by $C to prevent name
collisions in the following situations:

• $C is specified without $N.
• The length of $N plus the length of the text that you specify exceeds the Maximum identifier

length. Code generation truncates $N and inserts an 8-character checksum where you
specified $C in the formatting scheme.

.
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Identifier Format Control Parameters Limitations
The following limitations apply to the Identifier format control parameters:

• The following autogenerated identifiers currently do not fully comply with the setting of the
Maximum identifier length parameter on the Code Generation > Identifiers pane of the
Configuration Parameters dialog box.

• Model methods

• The applicable format scheme is $R$F, and the longest $F is _derivatives, which is 12
characters long. The model name can be up to 19 characters without exceeding the default
Maximum identifier length of 31.

• Local functions generated by S-functions or by add-on products such as DSP System Toolbox
that rely on S-functions

• Local variables generated by S-functions or by add-on products such as DSP System Toolbox
that rely on S-functions

• DW identifiers generated by S-functions in referenced models
• Fixed-point shared utility macros or shared utility functions
• Simulink rtm macros

• Most are within the default Maximum identifier length of 31, but some exceed the limit.
Examples are RTMSpecAccsGetStopRequestedValStoredAsPtr,
RTMSpecAccsGetErrorStatusPointer, and
RTMSpecAccsGetErrorStatusPointerPointer.

• Define protection guard macros

• Header file guards, such as _RTW_HEADER_$(filename)_h_, which can exceed the
default Maximum identifier length of 31 given a filename such as $R_private.h.

• Include file guards, such as _$R_COMMON_INCLUDES_.
• typedef guards, such as _CSCI_$R_CHARTSTRUCT_.

• In some situations, the following identifiers potentially can conflict with others.

• Model methods
• Reentrant model function arguments
• Local functions generated by S-functions or by add-on products such as DSP System Toolbox

that rely on S-functions
• Local variables generated by S-functions or by add-on products such as DSP System Toolbox

that rely on S-functions
• Fixed-point shared utility macros or shared utility functions
• Include header guard macros

• The following external identifiers that are unknown to the Simulink software might conflict with
autogenerated identifiers.

• Identifiers defined in custom code
• Identifiers defined in custom header files
• Identifiers introduced through a non-ANSI C standard library
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• Identifiers defined by custom TLC code
• Identifiers generated for simulation targets might exceed the Maximum identifier length.

Simulation targets include the model reference simulation target, the accelerated simulation
target, the RSim target, and the S-function target.

• Identifiers generated using a model name and bus object data type name, which are both long
names, might exceed the Maximum identifier length. For example, a ground value variable
name is generated as <model_name>_rtZ<bus_name>. If the model_name and bus_name are
close to the maximum identifier length, the name exceeds the maximum identifier length.
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Control Parentheses in Generated Code
C code contains some syntactically required parentheses, and can contain additional parentheses that
change semantics by overriding default operator precedence. C code can also contain optional
parentheses that have no functional significance, but only increase the readability of the code.
Optional C parentheses vary between two stylistic extremes:

• Include the minimum parentheses required by C syntax and precedence overrides so that C
precedence rules specify all semantics unless overridden by parentheses.

• Include the maximum parentheses that can exist without duplication so that C precedence rules
become irrelevant. Parentheses alone completely specify all semantics.

Understanding code with minimum parentheses can require applying nonobvious precedence rules.
Maximum parentheses can hinder code reading by belaboring obvious precedence rules. Various
parenthesization standards exist that specify one or the other extreme, or define an intermediate
style useful to people who read code.

Control Use of Parentheses
This example shows that Embedded Coder® provides three levels of control for parentheses in the
generated code.

model='rtwdemo_parentheses';
open_system(model)
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rtwdemoclean;
close_system(model,0)

See Also

Related Examples
• “Parentheses level”
• “Model Configuration Parameters: Code Style”
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Optimize Code by Reordering Commutable Operands
This example shows how to reorder commutable operands to make expressions left-recursive. Left -
recursive reordering saves stack space in memory. This optimization improves code efficiency.

Example Model
To reorder commutable operands, create this model and name it operand_order. The output signal
is the result of multiplying the signal from Inport block In1 by the sum of the signals from Inport
blocks In2 and In3.

Generate Code
1 Open the Model Configuration Parameters dialog box. On the Code Style tab, select the

Preserve operand order in expression parameter.
2 Generate code for the model.

In the operand_order.c file, the operand_order_step function contains this code:

operand_order_Y.Out1 = operand_order_U.In1 * (operand_order_U.In2 +
    operand_order_U.In3);

The code generator preserves the specified expression order in the model, which increases the
readability of the code for code traceability.

Generate Code with Optimization
1 Open the Model Configuration Parameters dialog box. On the Code Style tab, clear the Preserve

operand order in expression parameter.
2 Generate code for the model.

In the operand_order.c file, the operand_order_step function contains this code:

operand_order_Y.Out1 = (operand_order_U.In2 + operand_order_U.In3) *
    operand_order_U.In1;
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The code generator optimizes the code by reordering the commutable operands to make the
expression left-recursive, which improve code efficiency.

See Also

Related Examples
• “Preserve operand order in expression”
• “Model Configuration Parameters: Code Style”

53 Code Appearance in Embedded Coder

53-30



Suppress Generation of Default Cases for Unreachable
Stateflow Switch Statements

This example shows how to specify whether to generate default cases for switch-case statements in
the code for Stateflow charts. Generated code that does not contain default cases conserves ROM
consumption and enables better code coverage because every branch in the generated code is
falsifiable.

Some coding standards, such as MISRA, require the default case for switch-case statements. If you
want to increase your chances of producing MISRA C compliant code, generate default cases for
unreachable Stateflow switch statements.

Example
Figures 1, 2, and 3 show relevant portions of the sldemo_fuelsys model, a closed-loop system
containing a plant and controller. The Air-fuel rate controller logic is a Stateflow chart that specifies
the different operation modes.

Figure 1: Top-level model of the plant and controller
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Figure 2: Fuel rate controller subsystem

Figure 3: Fuel rate controller logic
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Generate Code with Default Cases for Unreachable Stateflow Switch
Statements
1 In the MATLAB Command Window, to open sldemo_fuelsys via rtwdemo_fuelsys enter:

rtwdemo_fuelsys
2 Open the Model Configuration parameters dialog box. On the Code Generation > Code Style

tab, clear the Suppress generation of default cases for Stateflow statements if
unreachable parameter.

3 In the MATLAB Command Window, to build the model, enter:

slbuild('sldemo_fuelsys/fuel_rate_control');

For the different operation modes, the fuel_rate_control.c file contains default cases for
unreachable switch statements. For example, for the Shutdown operation mode, the generated code
contains this default statement:

default:
 /* Unreachable state, for coverage only */
 rtDWork.bitsForTID0.is_Fuel_Disabled = IN_NO_ACTIVE_CHILD;
 break;

For the Warmup operation mode, the generated code contains this default statement:

default:
 /* Unreachable state, for coverage only */
 rtDWork.bitsForTID0.is_Low_Emissions = IN_NO_ACTIVE_CHILD;
 break;

Suppress Default Cases for Unreachable Stateflow Switch Statements
1 Open the Configuration Parameters dialog box. On the Code Generation > Code Style tab,

select the Suppress generation of default cases for Stateflow statements if unreachable
parameter.

2 Build the model.

Read through the fuel_rate_control.c file. The default cases for unreachable switch statements
are not in the generated code.

See Also

Related Examples
• “Suppress generation of default cases for Stateflow switch statements if unreachable”
• “Model Configuration Parameters: Code Style”
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Replace Multiplication by Powers of Two with Signed Bitwise
Shifts

This example shows how to generate code that replaces multiplication by powers of two with signed
bitwise shifts. Code that contains bitwise shifts executes faster than the code containing
multiplication by powers of two.

Some coding standards, such as MISRA, do not allow bitwise operations on signed integers. If you
want to increase your chances of producing MISRA C compliant code, do not replace multiplication
by powers of two with bitwise shifts.

Example
To replace multiplication by powers of two with bitwise shifts, create the following model. In this
model, a signal of Data type int16 feeds into a Shift Arithmetic block. In the Shift Arithmetic Block
Parameters dialog box, the Bits to shift > Direction parameter is set to Left. The Bits to shift >
Number parameter is set to 3. This parameter corresponds to a value of 8, or raising 2 to the power
of 3.

Generate Code with Signed Bitwise Shifts
1 Open the Model Configuration Parameters dialog box and select the Code Style tab. The

Replace multiplications by powers of two with signed bitwise shifts parameter is on by
default.

2 Generate code for the model.

In the bitwise_multiplication.c file, the bitwise_multiplication step function contains
this code:
bitwise_multiplication_Y.Out1 = (int16_T)(bitwise_multiplication_U.In1 << 3);

The signed integer, bitwise_multiplication_U.In1, is shifted three bits to the left.

Generate Code with Multiplication by Powers of Two
1 Open the Model Configuration Parameters dialog box and select the Code Style tab.
2 Clear the Replace multiplications by powers of two with signed bitwise shifts parameter.
3 Generate code for the model.

In the bitwise_multiplication.c file, the bitwise_multiplication step function contains
this code:
bitwise_multiplication_Y.Out1 = (int16_T)(bitwise_multiplication_U.In1 * 8);
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The signed integer bitwise_multiplication_U.In1 is multiplied by 8.

See Also

Related Examples
• “Replace multiplications by powers of two with signed bitwise shifts”
• “Model Configuration Parameters: Code Style”
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Generate Code Containing Right Shifts on Signed Integers
This example shows how to control whether the generated code contains right shifts on signed
integers. Generated code that does not contain right shifts on signed integers first casts the signed
integers to unsigned integers, and then right shifts the unsigned integers.

Some coding standards, such as MISRA, do not allow right shifts on signed integers because different
hardware can store negative integers differently. For negative integers, you can get different answers
depending on the hardware. If you want to increase your chances of producing MISRA C compliant
code, do not allow right shifts on signed integers.

Example Model
To generate code with right shifts on signed integers, create this model. A signal of Data type int16
feeds into a Shift Arithmetic block. In the Shift Arithmetic Block Parameters dialog box, the Bits to
shift > Direction parameter is set to Right. The Bits to shift > Number parameter is set to 3.

Generate Code Containing Right Shifts on Signed Integers
1 Open the Model Configuration Parameters dialog box and select the Code Style tab. The Allow

right shifts on signed integers parameter is on by default.
2 Generate code for the model.

In the rightshift.c file, the rightshift_step function contains this code:

rightshift_Y.Out1 = (int16_T)(rightshift_U.In1 >> 3);

The signed integer rightshift_U.In1 is shifted three bits to the right.

Generate Code That Does Not Allow Right Shifts on Signed Integers
1 Open the Model Configuration Parameters dialog box and select the Code Style tab. Clear the

Allow right shifts on signed integers parameter.
2 Generate code for the model.

In the rightshift.c file, the rightshift_step function contains this code:

rightshift_Y.Out1 = (int16_T)asr_s32(rightshift_U.In1, 3U);

When you clear the Allow right shifts on signed integers parameter, the generated code contains
a function call instead of a right shift on a signed integer. The function asr_s32 contains this code:

int32_T asr_s32(int32_T u, uint32_T n)
{
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  int32_T y;
  if (u >= 0) {
    y = (int32_T)((uint32_T)u >> n);
  } else {
    y = -(int32_T)((uint32_T)-(u + 1) >> n) - 1;
  }
 
  return y;
}

The asr_s32 function casts a signed integer to an unsigned integer, and then right shifts the
unsigned integer.

See Also

Related Examples
• “Allow right shifts on signed integers”
• “Model Configuration Parameters: Code Style”
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Control Cast Expressions in Generated Code
You can choose how the code generator specifies data type casts in the generated code. In the
Configuration Parameters dialog box, select Code Generation > Code Style. From the Casting
modes drop-down list, three parameter options control how the code generator casts data types.

• Nominal instructs the code generator to generate code that has minimal data type casting. When
you do not have special data type information requirements, choose Nominal.

• Standards Compliant instructs the code generator to cast data types to conform to MISRA
standards when it generates code. The MISRA data type casting eliminates common MISRA
standard violations, including address arithmetic and assignment. It reduces 10.1, 10.2, 10.3, and
10.4 violations.

For more information, see “MISRA C Guidelines” on page 23-5.
• Explicit instructs the code generator to cast data type values explicitly when it generates code.

You can see how a value is stored, which tells you how much memory space the code uses for the
variable. The data type informs you how much precision is possible in calculations involving the
variable.

Open the example model rtwdemo_rtwecintro.

Enable Nominal Casting Mode and Generate Code
When you choose Nominal casting mode, the code generator does not create data type casts for
variables in the generated code.

1 On the Code Generation > Code Style pane, from the Casting modes drop-down list, select
Nominal.

2 On the Code Generation > Report pane, select Create code generation report.
3 On the Code Generation pane, select Generate code only.
4 Click Apply.
5 In the model window, press Ctrl+B to generate code.
6 In the Code Generation report left pane, click rtwdemo_rtwecintro.c to see the code.
/* Model step function */
void rtwdemo_rtwecintro_step(void)
{
  boolean_T rtb_equal_to_count;
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  /* Sum: 'XRootX/Sum' incorporates:
   *  Constant: 'XRootX/INC'
   *  UnitDelay: 'XRootX/X'
   */
  rtDWork.X++;

  /* RelationalOperator: 'XRootX/RelOpt' incorporates:
   *  Constant: 'XRootX/LIMIT'
   */
  rtb_equal_to_count = (rtDWork.X != 16);

  /* Outputs for Triggered SubSystem: 'XRootX/Amplifier' incorporates:
   *  TriggerPort: 'XS1X/Trigger'
   */
  if (rtb_equal_to_count && (rtPrevZCSigState.Amplifier_Trig_ZCE != POS_ZCSIG))
  {
    /* Outport: 'XRootX/Output' incorporates:
     *  Gain: 'XS1X/Gain'
     *  Inport: 'XRootX/Input'
     */
    rtY.Output = rtU.Input << 1;
  }

  rtPrevZCSigState.Amplifier_Trig_ZCE = (uint8_T)(rtb_equal_to_count ? (int32_T)
    POS_ZCSIG : (int32_T)ZERO_ZCSIG);

  /* End of Outputs for SubSystem: 'XRootX/Amplifier' */

  /* Switch: 'XRootX/Switch' */
  if (!rtb_equal_to_count) {
    /* Update for UnitDelay: 'XRootX/X' incorporates:
     *  Constant: 'XRootX/RESET'
     */
    rtDWork.X = 0U;
  }
    
  /* End of Switch: 'XRootX/Switch' */
}

Enable Standards Compliant Casting Mode and Generate Code
When you choose Standards Compliant casting mode, the code generator creates MISRA
standards compliant data type casts for variables in the generated code.

1 On the Code Style pane, from the Casting modes drop-down list, select Standards
Compliant.

2 On the Code Generation pane, click Apply.
3 In the model window, press Ctrl+B to generate code.
4 In the Code Generation report left pane, click rtwdemo_rtwecintro.c to see the code.
void rtwdemo_rtwecintro_step(void)
{
  boolean_T rtb_equal_to_count;
    
  /* Sum: '<Root>/Sum' incorporates:
   *  Constant: '<Root>/INC'
   *  UnitDelay: '<Root>/X'
   */
  rtDWork.X++;

  /* RelationalOperator: '<Root>/RelOpt' incorporates:
   *  Constant: '<Root>/LIMIT'
   */
  rtb_equal_to_count = (boolean_T)(int32_T)((int32_T)rtDWork.X != (int32_T)16);

  /* Outputs for Triggered SubSystem: '<Root>/Amplifier' incorporates:
   *  TriggerPort: '<S1>/Trigger'
   */
  if (((int32_T)rtb_equal_to_count) && (rtPrevZCSigState.Amplifier_Trig_ZCE !=
       POS_ZCSIG)) {
    /* Outport: '<Root>/Output' incorporates:
     *  Gain: '<S1>/Gain'
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     *  Inport: '<Root>/Input'
     */
    rtY.Output = (int32_T)(uint32_T)((uint32_T)rtU.Input << (uint32_T)(int8_T)1);
  }

  rtPrevZCSigState.Amplifier_Trig_ZCE = (uint8_T)(int32_T)(rtb_equal_to_count ?
    (int32_T)(uint8_T)POS_ZCSIG : (int32_T)(uint8_T)ZERO_ZCSIG);

  /* End of Outputs for SubSystem: '<Root>/Amplifier' */

  /* Switch: '<Root>/Switch' */
  if (!rtb_equal_to_count) {
    /* Update for UnitDelay: '<Root>/X' incorporates:
     *  Constant: '<Root>/RESET'
     */
    rtDWork.X = 0U;
  }

  /* End of Switch: '<Root>/Switch' */
}

Enable Explicit Casting Mode and Generate Code
When you choose Explicit casting mode, the code generator creates explicit data type casts for
variables in the generated code.

1 On the Code Style pane, from the Casting modes drop-down list, select Explicit.
2 On the Code Generation pane, click Apply.
3 In the model window, press Ctrl+B to generate code.
4 In the Code Generation report left pane, click rtwdemo_rtwecintro.c to see the code.
/* Model step function */
void rtwdemo_rtwecintro_step(void)
{
  boolean_T rtb_equal_to_count;

  /* Sum: '<Root>/Sum' incorporates:
   *  Constant: '<Root>/INC'
   *  UnitDelay: '<Root>/X'
   */
  rtDWork.X = (uint8_T)(1U + (uint32_T)(int32_T)rtDWork.X);

  /* RelationalOperator: '<Root>/RelOpt' incorporates:
   *  Constant: '<Root>/LIMIT'
   */
  rtb_equal_to_count = (boolean_T)((int32_T)rtDWork.X != 16);

  /* Outputs for Triggered SubSystem: '<Root>/Amplifier' incorporates:
   *  TriggerPort: '<S1>/Trigger'
   */
  if (((int32_T)rtb_equal_to_count) && ((int32_T)((int32_T)
        rtPrevZCSigState.Amplifier_Trig_ZCE != (int32_T)POS_ZCSIG))) {
    /* Outport: '<Root>/Output' incorporates:
     *  Gain: '<S1>/Gain'
     *  Inport: '<Root>/Input'
     */
    rtY.Output = rtU.Input << 1;
  }

  rtPrevZCSigState.Amplifier_Trig_ZCE = (uint8_T)(rtb_equal_to_count ? (int32_T)
        POS_ZCSIG : (int32_T)ZERO_ZCSIG);

  /* End of Outputs for SubSystem: '<Root>/Amplifier' */

  /* Switch: '<Root>/Switch' */
  if (!(int32_T)rtb_equal_to_count) {
    /* Update for UnitDelay: '<Root>/X' incorporates:
     *  Constant: '<Root>/RESET'
     */
    rtDWork.X = 0U;
  }
    
  /* End of Switch: '<Root>/Switch' */
}
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See Also

Related Examples
• “Allow right shifts on signed integers”
• “Model Configuration Parameters: Code Style”
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Customize Code Organization and Format

In this section...
“Custom File Processing Components” on page 53-42
“Custom File Processing Configuration” on page 53-43

Custom file processing (CFP) tools allow you to customize the organization and formatting of
generated code. With these tools, you can:

• Generate a source (.c or .cpp) or header (.h) file. If you configure the Code interface
packaging for a model to be Reusable function or Nonreuseable function (not C++
class), you can use a custom file processing template to control how the code generator:

• Emits code to standard generated files---model.c or .cpp and model.h
• Produces files that are independent of model code

• Organize generated code into sections (such as includes, typedefs, functions, and more). Your
CFP template can emit code (for example, functions), directives (such as #define or #include
statements), or comments into each section.

• Generate custom file banners (comment sections) at the start and end of generated code files and
custom function banners that precede functions in the generated code.

• Generate code to call model functions, such as model_initialize, model_step, and so on.
• Generate code to read and write model inputs and outputs.
• Generate a main program module.
• Obtain information about the model and the generated files from the model.

Custom File Processing Components
The custom file processing features are based on the following interrelated components:

• Code generation template (CGT) files: a CGT file defines the top-level organization and formatting
of generated code. See “Code Generation Template (CGT) Files” on page 53-45.

• The code template API: a high-level Target Language Compiler (TLC) API that provides functions
with which you can organize code into named sections and subsections of generated source and
header files. The code template API also provides utilities that return information about generated
files, generate standard model calls, and perform other functions. See “Code Template API
Summary” on page 53-67.

• Custom file processing (CFP) templates: a CFP template is a TLC file that manages the process of
custom code generation. A CFP template assembles code to be generated into buffers. A CFP
template also calls the code template API to emit the buffered code into specified sections of
generated source and header files. A CFP template interacts with a CGT file, which defines the
ordering of major sections of the generated code. See “Custom File Processing (CFP) Templates”
on page 53-51.

To use CFP templates, you must understand TLC programming, for more information, see “Target
Language Compiler”.
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Custom File Processing Configuration
Customize generated code by specifying code and data templates on the Code Generation >
Templates pane:

Goal Action
Specify a template that defines the top-
level organization and formatting of
generated source code (.c or .cpp)
files

Enter a code generation template (CGT) file for the Source file (*.c)
template parameter.

Specify a template that defines the top-
level organization and formatting of
generated header (.h) files

Enter a CGT file for the Header file (*.h) template parameter. This
template file can be the same template file that you specify for Source
file (.c) template. If you use the same template file, source and
header files contain identical banners. The default template is
matlabroot/toolbox/rtw/targets/ecoder/
ert_code_template.cgt.

Specify a template that organizes
generated code into sections (such as
includes, typedefs, functions, and
more)

Enter a custom file processing (CFP) template file for the “File
customization template” parameter. A CFP template can emit code,
directives, or comments into each section. For more information, see
“Custom File Processing (CFP) Templates” on page 53-51.

Generate a model-specific example main
program module

Select Generate an example main program. For more information,
see “Generate a Standalone Program” on page 66-2.

Note Place the template files that you specify on the MATLAB path.
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Specify Templates For Code Generation
To use custom file processing features, create CGT files and CFP templates. These files are based on
default templates provided by the code generation software. Once you have created your templates,
you must integrate them into the code generation process.

Select and edit CGT files and CFP templates, and specify their use in the code generation process in
the Code Generation > Templates pane of a model configuration set. The following figure shows
options configured for their defaults.

The options related to custom file processing are:

• The Source file (.c) template field in the Code templates and Data templates sections. This
field specifies the name of a CGT file to use when generating source (.c or .cpp) files. You must
place this file on the MATLAB path.

• The Header file (.h) template field in the Code templates and Data templates sections. This
field specifies the name of a CGT file to use when generating header (.h) files. You must place this
file on the MATLAB path.

By default, the template for both source and header files is matlabroot/toolbox/rtw/
targets/ecoder/ert_code_template.cgt.

• The File customization template edit field in the Custom templates section. This field
specifies the name of a CFP template file to use when generating code files. You must place this
file on the MATLAB path. The default CFP template is matlabroot/toolbox/rtw/targets/
ecoder/example_file_process.tlc.

In each of these fields, click Browse to navigate to and select an existing CFP template or CGT file.
Click Edit to open the specified file into the MATLAB editor where you can customize it.
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Code Generation Template (CGT) Files
Code Generation Template (CGT) files define the top-level organization and formatting of generated
source code and header files. CGT files have the following applications:

• Generation of custom banners (comments sections) in code files. See “Generate Custom File and
Function Banners” on page 53-70.

• Generation of custom code using a CFP template requires a CGT file. To use CFP templates, you
must understand the CGT file structure. In many cases, however, you can use the default CGT file
without modifying it.

Default CGT file
The code generation software provides a default CGT file, matlabroot/toolbox/rtw/targets/
ecoder/ert_code_template.cgt. Base your custom CGT files on the default file.

CGT File Structure
A CGT file consists of one required section and four optional sections:

Code Insertion Section

(Required) This section contains tokens that define an ordered partitioning of the generated code into
a number of sections (such as Includes and Defines sections). Tokens have the form of:

%<SectionName>

For example,

%<Includes>

The code generation software defines a minimal set of required tokens. These tokens generate C or C
++ source or header code. They are built-in tokens (see “Built-In Tokens and Sections” on page 53-
46). You can also define custom tokens on page 53-63 and custom sections on page 53-62.

Each token functions as a placeholder for a corresponding section of generated code. The ordering of
the tokens defines the order in which the corresponding sections appear in the generated code. If you
do not include a token, then the corresponding section is not generated. To generate code into a
given section, explicitly call the code template API from a CFP template, as described in “Custom File
Processing (CFP) Templates” on page 53-51.

The CGT tokens define the high-level organization of generated code. Using the code template API,
you can partition each code section into named subsections, as described in “Subsections” on page
53-47.

In the code insertion section, you can also insert C or C++ comments between tokens. Such
comments emit directly into the generated code.

File Banner Section

(Optional) This section contains comments and tokens you use in generating a custom file banner.
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Function Banner Section

(Optional) This section contains comments and tokens for use in generating a custom function
banner.

Shared Utility Function Banner Section

(Optional) This section contains comments and tokens for use in generating a custom shared utility
function banner.

File Trailer Section

(Optional) This section contains comments for use in generating a custom trailer banner.

For more information on these sections, see “Generate Custom File and Function Banners” on page
53-70.

Built-In Tokens and Sections
The following code extract shows the required code insertion section of the default CGT file with the
required built-in tokens.
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Code insertion section (required)
%%   These are required tokens. You can insert comments and other tokens in
%% between them, but do not change their order or remove them.
%%
%<Includes>
%<Defines>
%<Types>
%<Enums>
%<Definitions>
%<Declarations>
%<Functions>

Note the following requirements for customizing a CGT file:

• Do not remove required built-in tokens.
• Built-in tokens must appear in the order shown because each successive section has dependencies

on previous sections.
• Only one token per line.
• Do not repeat tokens.
• You can add custom tokens and comments to the code insertion section as long as you do not

violate the previous requirements.

Note If you modify a CGT file and then rebuild your model, the code generation process does not
force a top model build. To regenerate the code, see “Force Regeneration of Top Model Code”.

The following table summarizes the built-in tokens and corresponding section names, and describes
the code sections.
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Built-In CGT Tokens and Corresponding Code Sections

Token and Section
Name

Description

Includes #include directives section
Defines #define directives section
Types typedef section.Typedefs can depend on a previously defined type
Enums Enumerated types section
Definitions Data definitions (for example, double x = 3.0;)
Declarations Data declarations (for example, extern double x;)
Functions C or C++ functions

Subsections
You can define one or more named subsections for any section. Some of the built-in sections have
predefined subsections summarized in table Subsections Defined for Built-In Sections.

Note Sections and subsections emit to the source or header file in the order listed in the CGT file.

Using the custom section feature, you can define additional sections. See “Generate a Custom
Section” on page 53-62.
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Subsections Defined for Built-In Sections

Section Subsections Subsection Description
Includes N/A  
Defines N/A  
Types IntrinsicTypes Intrinsic typedef section. Intrinsic types depend only

on intrinsic C or C++ types.
Types PrimitiveTypedefs Primitive typedef section. Primitive typedefs depend

only on intrinsic C or C++ types and on typedefs
previously defined in the IntrinsicTypes section.

Types UserTop You can place any type of code in this section, including
code that has dependencies on the previous sections.

Types Typedefs typedef section. Typedefs can depend on previously
defined types

Enums N/A  
Definitions N/A  
Declarations N/A  
Functions  C or C++ functions
Functions CompilerErrors #error directives
Functions CompilerWarnings #warning directives
Functions Documentation Documentation (comment) section
Functions UserBottom You can place any code in this section.
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Format Generated Code Files by Using Templates
This example shows how to use code generation templates to add custom code banners, rearrange
data and functions, and insert additional code segments and documentation into generated code files.

The model extracts text from the Model Description, a DOC block, and a Simulink annotation. The
Simulink annotation maps to the code template %<Note> symbol.

The templates provide consistent file layout and elaboration for your organization's coding standards.
Embedded Coder provides extensible code generation templates for formatting generated code. The
layout and format of the code template file controls the output of the generated code.

Code generation templates (.cgt files) enable you to add custom code banners, rearrange data and
functions, and insert additional code segments and documentation into the generated code files. Code
generation templates are imported automatically from the MATLAB path. For this model, the code
generation template rtwdemocodetemplate.cgt is used.

1. Open model rtwdemo_codetemplate.

model='rtwdemo_codetemplate';
open_system(model)

2. In the Configuration Parameters dialog box, open Code Generation > Templates pane.

3. In the Code templates section, click the Edit button beside Source file template. The
rtwdemocodetemplate.cgt template opens in the MATLAB Command Window. Inspect the code
template.

4. Build the model and generate code. On the C Code tab, click Build.

5. Open rtwdemo_codetemplate.c to inspect the generated code.
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rtwdemoclean;
close_system(model,0)
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Custom File Processing (CFP) Templates
The files provided to support custom file processing are:

• matlabroot/rtw/c/tlc/mw/codetemplatelib.tlc: A TLC function library that implements
the code template API. codetemplatelib.tlc also provides the comprehensive documentation
of the API in the comments headers preceding each function.

• matlabroot/toolbox/rtw/targets/ecoder/example_file_process.tlc: An example
custom file processing (CFP) template, which you should use as the starting point for creating
your own CFP templates. Guidelines and examples for creating a CFP template are provided in
“Generate Source and Header Files with a Custom File Processing (CFP) Template” on page 53-
58.

• TLC files supporting generation of single-rate and multirate main program modules (see
“Customizing Main Program Module Generation” on page 53-61).

Once you have created a CFP template, you must integrate it into the code generation process, using
the File customization template edit field. See “Specify Templates For Code Generation” on page
53-44.

Custom File Processing (CFP) Template Structure
A custom file processing (CFP) template imposes a simple structure on the code generation process.
The template, a code generation template (CGT) file, partitions the code generated for each file into a
number of sections. These sections are summarized in Built-In CGT Tokens and Corresponding Code
Sections and Subsections Defined for Built-In Sections.

Code for each section is assembled in buffers and then emitted, in the order listed, to the file being
generated.

To generate a file section, your CFP template must first assemble the code to be generated into a
buffer. Then, to emit the section, your template calls the TLC function

LibSetSourceFileSection(fileH, section, tmpBuf)

where

• fileH is a file reference to a file being generated.
• section is the code section or subsection to which code is to be emitted. section must be one of

the section or subsection names listed in Subsections Defined for Built-In Sections.

Determine the section argument as follows:

• If Subsections Defined for Built-In Sections does not define subsections for a given section, use
the section name as the section argument.

• If Subsections Defined for Built-In Sections defines one or more subsections for a given
section, you can use either the section name or a subsection name as the section argument.

• If you have defined a custom token denoting a custom section, do not call
LibSetSourceFileSection. Special API calls are provided for custom sections (see
“Generate a Custom Section” on page 53-62).

• tmpBuf is the buffer containing the code to be emitted.
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There is no requirement to generate all of the available sections. Your template need only generate
the sections you require in a particular file.

Note that legality or syntax checking is not performed on the custom code within each section.

See “Generate Source and Header Files with a Custom File Processing (CFP) Template” on page 53-
58, for typical usage examples.

Generate Additional Files Required to Interface with an Application
Embedded Coder® provides an extensible API to augment generated code and to generate additional
files. The model configuration parameter File customization template specifies a custom Target
Language Compiler (TLC) script that executes at the end of the code generation process. Using this
script, you can generate additional code to interface with application code.

In this example, the TLC script file rtwdemofileprocess.tlc creates an additional entry-point
function, rtwdemo_fileprocess, which calls the step function and initializes the model, if
necessary. The initialization function is transparent to the caller.

1. Open the example model rtwdemo_fileprocess.

open_system('rtwdemo_fileprocess');

2. Verify the model configuration parameter File customization template is set to
rtwdemofileprocess.tlc by double-clicking the yellow button labeled View Templates
Configuration.

3. Generate code.
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4. Inspect the generated code. An additional function, rtwdemo_fileprocess, appears at the end of
the generated file rtwdemo_fileprocess.c. The entry point is declared extern in
rtwdemo_fileprocess.h as the rtwdemofileprocess.tlc script specifies.
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Change the Organization of a Generated File
The files created during code generation are organized according to the general code generation
template. This template has the filename ert_code_template.cgt, and is specified by default in
Code Generation > Templates pane of the Configuration Parameters dialog box.

The following fragment shows the rtwdemo_configinterface.c file header that is generated
using this default template:

/*
* File: rtwdemo_configinterface.c
*
* Code generated for Simulink model 'rtwdemo_configinterface'.
*
* Model version                  : 1.387
* Simulink Coder version         : 9.4 (R2020b) 19-May-2020
* C/C++ source code generated on : Thu Jun 11 14:31:07 2020
*
* Target selection: ert.tlc
* Embedded hardware selection: Intel->x86-64 (Windows64)
* Code generation objectives: Unspecified
* Validation result: Not run
*/

You can change the organization of generated files using code templates and data templates. Code
templates organize the files that contain functions, primarily. Data templates organize the files that
contain identifiers. In this procedure, you organize the generated files, using the supplied code and
data templates:

1 In the Configuration Parameters dialog box, open the Code Generation > Templates pane.
2 In the Code templates section, in the Source file template box, type code_c_template.cgt.
3 In the Header file template box, type code_h_template.cgt.
4 In the Data templates section, in the Source file template box, type data_c_template.cgt.
5 In the Header file template box, type data_h_template.cgt.
6 Click Apply.
7 In the model window, press Ctrl+B. Now the files are organized using the templates you

specified. For example, the rtwdemo_configinterface.c file header now is organized like
this:
/**
 ******************************************************
 **  FILE INFORMATION:
 **  Filename:           rtwdemo_configinterface.c
 **  File Creation Date: 11-Jun-2020
 **
 **  ABSTRACT:
 **
 **
 **  NOTES:
 **
 **
 **  MODEL INFORMATION:
 **  Model Name:         rtwdemo_configinterface
 **  Model Description:  Data Dictionary Driven Modeling Using 
     Simulink(R) Data Objects

   This model shows how to use Simulink data objects to define data 
   independently from the diagram which supports a data dictionary 
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   driven modeling style.
 **  Model Version:      1.387
 **  Model Author:       The MathWorks, Inc. - Mon Nov 27 14:36:56 2000
 **
 **  MODIFICATION HISTORY:
 **  Model at Code Generation: user - Thu Jun 11 14:38:31 2020
 **
 **  Last Saved Modification:  The MathWorks, Inc. - Thu Jun 04 02:05:40 2020
 **
 **
 *******************************************************************************
 **/
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Customize Generated File Names
The code generator creates model.* files during the code generation and build process. When you
generate C/C++ code for ERT-based models, you can customize the names of the generated header,
source, and data files. You cannot customize the generated files for referenced models. Custom file
names enable you to:

• Comply with naming standards of the company or industry.
• Integrate with external code.

In the Configuration Parameters dialog box, on the Code Generation > Code Placement pane, use
the Auto-generated file naming rules group to customize the names of generated files. When you
use Modular or Compact(with separate date file) file packaging, you can specify custom
names for generated header, source, and data files. When you use Compact file packaging, you can
specify custom names for generated header and source files.

1 Open any ERT-based model, for example, rtwdemo_dynamicio. In the Configuration Parameters
dialog box, change the System target file to ert.tlc.

2 On the Code Generation > Code Placement pane, select File packaging format as
Compact(with separate date file).

3 Specify custom file names by using the naming rules for these parameters:

• Header files: $R$E_header
• Source files: $R$E_source
• Data files: $R_data

$E is mandatory for Header files and Source files. $E represents these instances of file types:

• capi
• capi_host
• dt
• testinterface
• private
• types

4 To build the model, press Ctrl + B. In the code generation report, the generated files are listed
on the left pane under Model files and Data files section.
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In this example, $E resolves to private and types. The generated header files resolve to the
model name with the value for $E and custom text header. The generated source files resolve to
the model name with custom text source. The generated data file resolves to the model name
with custom text data. Here is a summary of naming rules applied and the corresponding
generated files:

Type of
File

Token Specification Custom Text Generated File
Name

Header file $R$E header rtwdemo_dynamicio
_header.h

Header file $R$E header rtwdemo_dynamicio
_private_header.h

Source file $R$E source rtwdemo_dynamicio
_source.c

Header file $R$E header rtwdemo_dynamicio
_types_header.h

Data file $R data rtwdemo_dynamicio
_data.c

See Also

Related Examples
• “Model Configuration Parameters: Code Generation Code Placement”
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Generate Source and Header Files with a Custom File
Processing (CFP) Template

In this section...
“Generate Code with a CFP Template” on page 53-58
“Analysis of the Example CFP Template and Generated Code” on page 53-59
“Generate a Custom Section” on page 53-62
“Custom Tokens” on page 53-63

This example shows you the process of generating a simple source (.c or .cpp) and header (.h) file
using the example CFP template. Then, it examines the template and the code generated by the
template.

The example CFP template, matlabroot/toolbox/rtw/targets/ecoder/
example_file_process.tlc, demonstrates some of the capabilities of the code template API,
including

• Generation of simple source (.c or .cpp) and header (.h) files
• Use of buffers to generate file sections for includes, functions, and so on
• Generation of includes, defines, into the standard generated files (for example, model.h)
• Generation of a main program module

Generate Code with a CFP Template
This section sets up a CFP template and configures a model to use the template in code generation.
The template generates (in addition to the standard model files) a source file (timestwo.c or .cpp)
and a header file (timestwo.h).

Follow the steps below to become acquainted with the use of CFP templates:

1 Copy the example CFP template, matlabroot/toolbox/rtw/targets/ecoder/
example_file_process.tlc, to a folder outside of the MATLAB folder structure (that is, not
under matlabroot). If the folder is not on the MATLAB path or the TLC path, then add it to the
MATLAB path. It is good practice to locate the CFP template in the same folder as your system
target file, which is on the TLC path.

2 Rename the copied example_file_process.tlc to test_example_file_process.tlc.
3 Open test_example_file_process.tlc into the MATLAB editor.
4 Uncomment the following line:

%%  %assign ERTCustomFileTest = TLC_TRUE

It now reads:

  %assign ERTCustomFileTest = TLC_TRUE

If ERTCustomFileTest is not assigned as shown, the CFP template is ignored in code
generation.

5 Save your changes to the file. Keep test_example_file_process.tlc open, so you can refer
to it later.
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6 Open the rtwdemo_udt model.
7 Open the Simulink Model Explorer. Select the active configuration set of the model, and open the

Code Generation pane of the active configuration set.
8 On the Templates tab, in the File customization template field, specify

test_example_file_process.tlc. This is the file you previously edited and is now the
specified CFP template for your model.

9 On the General tab, select the Generate code only check box.
10 Click Apply.
11 In the model window, press Ctrl+B. During code generation, notice the following message in the

Diagnostic Viewer:

Warning:  Overriding example ert_main.c!

This message is displayed because test_example_file_process.tlc generates the main
program module, overriding the default action of the ERT target. This is explained in greater
detail below.

12 The rtwdemo_udt model is configured to generate an HTML code generation report. After code
generation is complete, view the report.

Notice that the Generated Code list contains the following files:

• Under Main file, ert_main.c.
• Under Other files, timestwo.c and timestwo.h.

The files were generated by the CFP template. The next section examines the template to learn
how this was done.

13 Keep the model, the code generation report, and the test_example_file_process.tlc file
open so you can refer to them in the next section.

Analysis of the Example CFP Template and Generated Code
This section examines excerpts from test_example_file_process.tlc and some of the code it
generates. Refer to the comments in matlabroot/rtw/c/tlc/mw/codetemplatelib.tlc while
reading the following discussion.

Generating Code Files

Source (.c or .cpp) and header (.h) files are created by calling LibCreateSourceFile, as in the
following excerpts:
%assign cFile = LibCreateSourceFile("Source", "Custom", "timestwo")
...
%assign hFile = LibCreateSourceFile("Header", "Custom", "timestwo")

Subsequent code refers to the files by the file reference returned from LibCreateSourceFile.

File Sections and Buffers

The code template API lets you partition the code generated to each file into sections, tagged as
Definitions, Includes, Functions, Banner, and so on. You can append code to each section as
many times as required. This technique gives you a great deal of flexibility in the formatting of your
custom code files.

 Generate Source and Header Files with a Custom File Processing (CFP) Template

53-59

matlab:rtwdemo_udt


Subsections Defined for Built-In Sections describes the available file sections and their order in the
generated file.

For each section of a generated file, use %openfile and %closefile to store the text for that
section in temporary buffers. Then, to write (append) the buffer contents to a file section, call
LibSetSourceFileSection, passing in the desired section tag and file reference. For example, the
following code uses two buffers (typesBuf and tmpBuf) to generate two sections (tagged
"Includes" and "Functions") of the source file timestwo.c or .cpp (referenced as cFile):

%openfile typesBuf

#include "rtwtypes.h"

%closefile typesBuf

%<LibSetSourceFileSection(cFile,"Includes",typesBuf)>

 %openfile tmpBuf

 /* Times two function */
 real_T timestwofcn(real_T input) {
   return (input * 2.0);
}

%closefile tmpBuf

%<LibSetSourceFileSection(cFile,"Functions",tmpBuf)>

These two sections generate the entire timestwo.c or .cpp file:

#include "rtwtypes.h"

/* Times two function */
FLOAT64 timestwofcn(FLOAT64 input)
{
  return (input * 2.0);
}

Adding Code to Standard Generated Files

The timestwo.c or .cpp file generated in the previous example was independent of the standard
code files generated from a model (for example, model.c or .cpp, model.h, and so on). You can use
similar techniques to generate custom code within the model files. The code template API includes
functions to obtain the names of the standard models files and other model-related information. The
following excerpt calls LibGetMdlPubHdrBaseName to obtain the name for the model.h file. It then
obtains a file reference and generates a definition in the Defines section of model.h:
%% Add a #define to the model's public header file model.h

%assign pubName = LibGetMdlPubHdrBaseName()
%assign modelH  = LibCreateSourceFile("Header", "Simulink", pubName)

%openfile tmpBuf

 #define ACCELERATION 9.81

 %closefile tmpBuf

%<LibSetSourceFileSection(modelH,"Defines",tmpBuf)>
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Examine the generated rtwdemo_udt.h file to see the generated #define directive.

Customizing Main Program Module Generation

Normally, the ERT target determines whether and how to generate an ert_main.c or .cpp module
based on the settings of the Generate an example main program and Target operating system
options on the Templates pane of the Configuration Parameters dialog box. You can use a CFP
template to override the normal behavior and generate a main program module customized for your
target environment.

To support generation of main program modules, two TLC files are provided:

• bareboard_srmain.tlc: TLC code to generate an example single-rate main program module for
a bareboard target environment. Code is generated by a single TLC function,
FcnSingleTaskingMain.

• bareboard_mrmain.tlc: TLC code to generate a multirate main program module for a
bareboard target environment. Code is generated by a single TLC function,
FcnMultiTaskingMain.

In the example CFP template file matlabroot/toolbox/rtw/targets/ecoder/
example_file_process.tlc, the following code generates either a single- or multitasking
ert_main.c or .cpp module. The logic depends on information obtained from the code template API
calls LibIsSingleRateModel and LibIsSingleTasking:

%% Create a simple main.  Files are located in MATLAB/rtw/c/tlc/mw.

 %if LibIsSingleRateModel() || LibIsSingleTasking()
   %include "bareboard_srmain.tlc"
   %<FcnSingleTaskingMain()>
 %else
   %include "bareboard_mrmain.tlc"
   %<FcnMultiTaskingMain()>
 %endif

Note that bareboard_srmain.tlc and bareboard_mrmain.tlc use the code template API to
generate ert_main.c or .cpp.

When generating your own main program module, you disable the default generation of ert_main.c
or .cpp. The TLC variable GenerateSampleERTMain controls generation of ert_main.c or .cpp.
You can directly force this variable to TLC_FALSE. The examples bareboard_mrmain.tlc and
bareboard_srmain.tlc use this technique, as shown in the following excerpt from
bareboard_srmain.tlc.

%if GenerateSampleERTMain
    %assign CompiledModel.GenerateSampleERTMain = TLC_FALSE
    %warning Overriding example ert_main.c!
%endif

Alternatively, you can implement a SelectCallback function for your target. A SelectCallback
function is a MATLAB function that is triggered when you:

• Load the model.
• Update any configuration settings in the Configuration Parameters dialog box.
• Build the model.
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Your SelectCallback function should deselect and disable the Generate an example main
program option. This prevents the TLC variable GenerateSampleERTMain from being set to
TLC_TRUE.

See the “rtwgensettings Structure” section for information on creating a SelectCallback function.

The following code illustrates how to deselect and disable the Generate an example main program
option in the context of a SelectCallback function.

slConfigUISetVal(hDlg, hSrc, 'GenerateSampleERTMain', 'off');
slConfigUISetEnabled(hDlg, hSrc, 'GenerateSampleERTMain',0);
hSrc.refreshDialog;

Note Creation of a main program for your target environment requires some customization; for
example, in a bareboard environment you need to attach rt_OneStep to a timer interrupt. It is
expected that you will customize either the generated code, the generating TLC code, or both. See
“Guidelines for Modifying the Main Program” on page 66-3 and “Guidelines for Modifying
rt_OneStep” on page 66-7 for further information.

Generate a Custom Section
You can define custom tokens on page 53-63 in a CGT file and direct generated code into an
associated built-in section. This feature gives you additional control over the formatting of code
within each built-in section. For example, you could add subsections to built-in sections that do not
already define subsections. Custom sections must be associated with one of the built-in sections:
Includes, Defines, Types, Enums, Definitions, Declarations, or Functions. To create
custom sections, you must

• Add a custom token to the code insertion section of your CGT file.
• In your CFP file:

• Assemble code to be generated to the custom section into a buffer.
• Declare an association between the custom section and a built-in section, with the code

template API function LibAddSourceFileCustomSection.
• Emit code to the custom section with the code template API function

LibSetSourceFileCustomSection.

The following code examples illustrate the addition of a custom token, Myincludes, to a CGT file,
and the subsequent association of the custom section Myincludes with the built-in section
Includes in a CFP file.

Note If you have not already created custom CGT and CFP files for your model, copy the default
template files matlabroot/toolbox/rtw/targets/ecoder/ert_code_template.cgt and
matlabroot/toolbox/rtw/targets/ecoder/example_file_process.tlc to a work folder
that is outside the MATLAB folder structure but on the MATLAB or TLC path, rename them (for
example, add the prefix test_ to each file), and update the Templates pane of the Configuration
Parameters dialog box to reference them.

First, add the token Myincludes to the code insertion section of your CGT file. For example:
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%<Includes>
%<Myincludes>
%<Defines>
%<Types>
%<Enums>
%<Definitions>
%<Declarations>
%<Functions>

Next, in the CFP file, add code to generate include directives into a buffer. For example, in your
copy of the example CFP file, you could insert the following section between the Includes section
and the Create a simple main section:

%% Add a custom section to the model's C file model.c

%openfile tmpBuf
#include "moretables1.h"
#include "moretables2.h"
%closefile tmpBuf

%<LibAddSourceFileCustomSection(modelC,"Includes","Myincludes")>
%<LibSetSourceFileCustomSection(modelC,"Myincludes",tmpBuf)>

The LibAddSourceFileCustomSection function call declares an association between the built-in
section Includes and the custom section Myincludes. Myincludes is a subsection of Includes.
The LibSetSourceFileCustomSection function call directs the code in the tmpBuf buffer to the
Myincludes section of the generated file. LibSetSourceFileCustomSection is syntactically
identical to LibSetSourceFileSection.

In the generated code, the include directives generated to the custom section appear after other code
directed to Includes.

#include "rtwdemo_udt.h"
#include "rtwdemo_udt_private.h"

/* #include "mytables.h" */
#include "moretables1.h"
#include "moretables2.h"

Note The placement of the custom token in this example CGT file is arbitrary. By locating
%<Myincludes> after %<Includes>, the CGT file specifies only that the Myincludes code appears
after Includes code.

Custom Tokens
Custom tokens are automatically translated to TLC syntax as a part of the build process. To escape a
token, that is to prepare it for normal TLC expansion, use the '!' character. For example, the token
%<!TokenName> is expanded to %<TokenName> by the template conversion program. You can specify
valid TLC code, including TLC function calls: %<!MyTLCFcn()>.

Custom tokens are not supported when you generate C++ code.
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Comparison of a Template and Its Generated File
This figure shows part of a user-modified custom file processing (CFP) template and the resulting
generated code. The figure illustrates how you can use a template to:

• Define what code the code generation software should add to the generated file
• Control the location of code in the file
• Optionally insert comments in the generated file

Notice %<Includes>, for example, on the template. The term Includes is a symbol name. A percent
sign and brackets (%< >) must enclose every symbol name. You can add the desired symbol name
(within the %< > delimiter) at a particular location in the template. This is how you control where the
code generator places an item in the generated file.

Template and Generated File
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Mapping Template Specification to Code Generation

This part of the template... Generates in the file... Explanation
Line Description

(1) /*#INCLUDES*/
%<Includes>

26–28 An /*#INCLUDES*/
comment, followed by
#include statements

The code generator adds the C/C++
comment as a header, and then
interprets the %<Includes> template
symbol to list the required #include
statements in the file. This code is
first in this section of the file because
the template entries are first.

(2) /*#DEFINES*/
%<Defines>

30 A /*#DEFINES*/
comment, but no
#define statements

Next, the code generator places the
comment as a header for #define
statements, but the file does not need
#define. No code is added.

(3) #pragma string1 31 #pragma statements While the code generator requires
%<> delimiters for template symbols,
it can also interpret C/C++
statements in the template without
delimiters. In this case, the generator
adds the specified statements to the
code, following the order in which the
statements appear in the template.

(5) #pragma string2 42

(4) /*DEFINITIONS*/
%<Definitions>

32–41 /*DEFINITIONS*/
comment, followed by
definitions

The code generator places the
comment and definitions in the file
between the #pragma statements,
according to the order in the
template. It also inserts comments
(lines 33 and 36) that are preset in
the model's Configuration Parameters
dialog box.

(6) %<Declarations> 43 No declarations The file needs no declarations, so the
code generator does not generate
declarations for this file. The template
does not have a comment to provide a
header. Line 43 is left blank.

(7) %<Functions> 44–74 Functions Finally, the code generator adds
functions from the model, plus
comments that are preset in the
Configuration Parameters dialog box.
But it adds no comments as a header
for the functions, because the
template does not have one. This code
is last because the template entry is
last.

For a list of template symbols and the rules for using them, see “Template Symbol Groups” on page
53-77, “Template Symbols” on page 53-79, and “Rules for Modifying or Creating a Template” on
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page 53-81. To set comment options, in the Configuration Parameters dialog box, select the Code
Generation > Comments pane. For details, see “Configure Code Comments”.
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Code Template API Summary
Code Template API Functions summarizes the code template API. See the source code in
matlabroot/rtw/c/tlc/mw/codetemplatelib.tlc for detailed information on the arguments,
return values, and operation of these calls.
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Code Template API Functions

Function Description
LibClearFileSectionContents Clears a file section with custom values before

writing file to disk.
LibGetNumSourceFiles Returns the number of created source files (.c

or .cpp and .h).
LibGetSourceFileTag Returns <filename>_h and <filename>_c for

header and source files, respectively, where
filename is the name of the model file.

LibCreateSourceFile Creates a new C or C++ file and returns its
reference. If the file already exists, simply returns
its reference.

LibGetFileRecordName Returns a model file name (including the path)
without the extension.

LibGetSourceFileFromIdx Returns a model file reference based on its index.
This is useful for a common operation on all files,
such as to set the leading file banner of all files.

LibSetSourceFileSection Adds to the contents of a specified section within a
specified file (see also “Custom File Processing
(CFP) Template Structure” on page 53-51).

LibIndentSourceFile Indents a file (from within the TLC environment).
LibCallModelInitialize Returns code for calling the model's

model_initialize function (valid for ERT only).
LibCallModelStep Returns code for calling the model's model_step

function (valid for ERT only).
LibCallModelTerminate Returns code for calling the model's

model_terminate function (valid for ERT only).
LibCallSetEventForThisBaseStep Returns code for calling the model's set events

function (valid for ERT only).
LibWriteModelData Returns data for the model (valid for ERT only).
LibSetRTModelErrorStatus Returns the code to set the model error status.
LibGetRTModelErrorStatus Returns the code to get the model error status.
LibIsSingleRateModel Returns true if model is single rate and false

otherwise.
LibGetModelName Returns name of the model (without an extension).
LibGetMdlSrcBaseName Returns the name of model's main source file (for

example, model.c or .cpp).
LibGetMdlPubHdrBaseName Returns the name of model's public header file

(for example, model.h).
LibGetMdlPrvHdrBaseName Returns the name of the model's private header

file (for example, model_private.h).
LibIsSingleTasking Returns true if the model is configured for single-

tasking execution.
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Function Description
LibWriteModelInput Returns the code to write to a particular root

input (that is, a model inport block). (valid for ERT
only).

LibWriteModelOutput Returns the code to write to a particular root
output (that is, a model outport block). (valid for
ERT only).

LibWriteModelInputs Returns the code to write to root inputs (that is,
all model inport blocks). (valid for ERT only)

LibWriteModelOutputs Returns the code to write to root outputs (that is,
all model outport blocks). (valid for ERT only).

LibNumDiscreteSampleTimes Returns the number of discrete sample times in
the model.

LibSetSourceFileCodeTemplate Set the code template to be used for generating a
specified source file.

LibSetSourceFileOutputDirectory Set the folder into which a specified source file is
to be generated.

LibAddSourceFileCustomSection Add a custom section to a source file. The custom
section must be associated with one of the built-in
(required) sections: Includes, Defines, Types,
Enums, Definitions, Declarations, or
Functions.

LibSetSourceFileCustomSection Adds to the contents of a specified custom section
within a specified file. The custom section must
have been previously created with
LibAddSourceFileCustomSection.

 Code Template API Summary

53-69



Generate Custom File and Function Banners
Using code generation template (CGT) files, you can specify custom file banners and function banners
for the generated code files. File banners are comment sections in the header and trailer sections of a
generated file. Function banners are comment sections for each function in the generated code. Use
these banners to add a company copyright statement, specify a special version symbol for your
configuration management system, remove time stamps, and for many other purposes. These banners
can contain characters, which propagate to the generated code.

To specify banners, create a custom CGT file with customized banner sections. The build process
creates an executable TLC file from the CGT file. The code generation process then invokes the TLC
file.

You do not need to be familiar with TLC programming to generate custom banners. You can modify
example files that are supplied with the ERT target.

Note Prior releases supported direct use of customized TLC files as banner templates. You specified
these with the Source file (.c) banner template and Header file (.h) banner template options of
the ERT target. You can still use a custom TLC file banner template, however, you can now use CGT
files instead.

ERT template options on the Code Generation > Templates pane of a configuration set, in the Code
templates section, support banner generation.

The options for function and file banner generation are:

• “Code templates: Source file (*.c) template”: CGT file to use when generating source (.c or .cpp)
files. Place this file on the MATLAB path.

• “Code templates: Header file (*.h) template”: CGT file to use when generating header (.h) files.
You must place this file on the MATLAB path. This file can be the same template specified in the
Code templates: Source file (*.c) template field, in which case identical banners are generated
in source and header files.

By default, the template for both source and header files is matlabroot/toolbox/rtw/
targets/ecoder/ert_code_template.cgt.

• In each of these fields, click Browse to navigate to and select an existing CGT file for use as a
template. Click Edit to open the specified file into the MATLAB editor, where you can customize it.

Create a Custom File and Function Banner Template
To customize a CGT file for custom banner generation, make a local copy of the default code template
and edit it, as follows:

1 Activate the configuration set that you want to work with.
2 Open the Code Generation pane of the active configuration set.
3 Click the Templates tab.
4 By default, the code template specified in the Code templates: Source file (*.c) template and

Code templates: Header file (*.h) template fields is matlabroot/toolbox/rtw/targets/
ecoder/ert_code_template.cgt.
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5 If you want to use a different template as your starting point, click Browse to locate and select a
CGT file.

6 Click Edit button to open the CGT file into the MATLAB editor.
7 Save a local copy of the CGT file. Store the copy in a folder that is outside of the MATLAB folder

structure, but on the MATLAB path. If required, add the folder to the MATLAB path.
8 If you intend to use the CGT file with a custom target, locate the CGT file in a folder under your

target root folder.
9 Rename your local copy of the CGT file. When you rename the CGT file, update the associated

Code templates: Source file (*.c) template or Code templates: Header file (*.h) template
field to match the new file name.

10 Edit and customize the local copy of the CGT file for banner generation, using the information
provided in “Customize a Code Generation Template (CGT) File for File and Function Banner
Generation” on page 53-71.

11 Save your changes to the CGT file.
12 Click Apply to update the configuration set.
13 Save your model.
14 Generate code. Examine the generated source and header files to confirm that they contain the

banners specified by the template or templates.

Customize a Code Generation Template (CGT) File for File and
Function Banner Generation
This section describes how to edit a CGT file for custom file and function banner generation. For a
description of CGT files, see “Code Generation Template (CGT) Files” on page 53-45.

Components of the File and Function Banner Sections in the CGT file

In a CGT file, you can modify the following sections: file banner, function banner, shared utility
function banner, and file trailer. Each section is defined by open and close tags. The tags specific to
each section are shown in the following table.

CGT File Section Open Tag Close Tag
File Banner on page 53-73 <FileBanner> </FileBanner>
Function Banner on page 53-74 <FunctionBanner> </FunctionBanner>
Shared-utility Banner on page 53-
75

<SharedUtilityBanner> </SharedUtilityBanner>

File Trailer on page 53-75 <FileTrailer> </FileTrailer>

You can customize your banners by including tokens and comments between the open and close tag
for each section. Tokens are typically TLC variables, for example <ModelVersion>, which are
replaced with values in the generated code.

Note Including C comment indicators, '/*' or a '*/', in the contents of your banner might introduce an
error in the generated code.
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An open tag includes tag attributes. Enclose the value of the attribute in double quotes. The
attributes available for an open tag are:

• width: specifies the width of the file or function banner comments in the generated code. The
default value is 80.

• style: specifies the boundary for the file or function banner comments in the generated code.

The open tag syntax is as follows:

<OpenTag style = “style_value” width = “num_width”>

Note If the Configuration Parameters > Code Generation > Language parameter is set to C++,
to select a comment style that uses C comment notation (/*...*/), you must also set the
Configuration Parameters > Comments > Comment style parameter to Multi-line.

The built-in style options for the style attribute are:

• classic

/* single line comments */
/*
 * multiple line comments
 * second line
 */

• classic_cpp

// single line comments
//
// multiple line comments
// second line
//

• box

/**********************************************************/
/* banner contents                                        */
/**********************************************************/

• box_cpp

////////////////////////////////////////////////////////////
// banner contents                                        //
////////////////////////////////////////////////////////////

• open_box

/**********************************************************
 * banner contents
 **********************************************************/

• open_box_cpp

////////////////////////////////////////////////////////////
// banner contents
////////////////////////////////////////////////////////////

• doxygen

53 Code Appearance in Embedded Coder

53-72



/** single line comments */

/**
 * multiple line comments
 * second line
 */

• doxygen_cpp

/// single line comments

///
/// multiple line comments
/// second line
///

• doxygen_qt

/*! single line comments */

/*!
 * multiple line comments
 * second line
 */

• doxygen_qt_cpp

//! single line comments

//!
//! multiple line comments
//! second line
//!

File Banner

This section contains comments and tokens for use in generating a custom file banner. The file banner
precedes C or C++ code generated by the model. If you omit the file banner section from the CGT
file, then no file banner emits to the generated code.

Note If you customize your file banner, the software does not emit the customized banner for the file
const_params.c.

The following section is the file banner section provided with the default CGT file, matlabroot/
toolbox/rtw/targets/ecoder/ert_code_template.cgt.

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom file banner section (optional)
%%
<FileBanner style="classic">
File: %<FileName>

Code generated for Simulink model %<ModelName>.

Model version                        : %<ModelVersion>
Simulink Coder version               : %<RTWFileVersion>
C/C++ source code generated on       : %<SourceGeneratedOn>
%<CodeGenSettings>
</FileBanner>
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Summary of Tokens for File Banner Generation

FileName Name of the generated file (for example, "rtwdemo_udt.c").
FileType Either "source" or "header". Designates whether generated

file is a .c or .cpp file or an .h file.
FileTag Given file names file.c or .cpp and file.h; the file tags are

"file_c" and "file_h", respectively.
ModelName Name of generating model.
ModelVersion Version number of model.
Description Description of the model specified in the CGT file or the text

specified in the Descripton tab in Model Properties (Modeling
> Model Settings). This token is not supported for referenced
models in a model reference hierarchy.

RTWFileVersion Version number of model.rtw file.
RTWFileGeneratedOn Timestamp of model.rtw file.
TLCVersion Version of Target Language Compiler.
SourceGeneratedOn Timestamp of generated file.
CodeGenSettings Code generation settings for model: target language, target

selection, production hardware selection, test hardware selection,
code generation objectives (in priority order), and Code
Generation Advisor validation result.

Function Banner

This section contains comments and tokens for use in generating a custom function banner. The
function banner precedes C or C++ function generated during the build process. If you omit the
function banner section from the CGT file, the default function banner emits to the generated code.
The following section is the default function banner section provided with the default CGT file,
matlabroot/toolbox/rtw/targets/ecoder/ert_code_template.cgt.
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom function banner section (optional)
%%   Customize function banners by using the following predefined tokens:
%% %<ModelName>, %<FunctionName>, %<FunctionDescription>, %<Arguments>,
%% %<ReturnType>, %<GeneratedFor>, %<BlockDescription>.
%%
<FunctionBanner style="classic">
%<FunctionDescription>
%<BlockDescription>
</FunctionBanner>
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Summary of Tokens for Function Banner Generation

FunctionName Name of function
Arguments List of function arguments
ReturnType Return type of function
ModelName Name of generating model
FunctionDescription Short abstract about the function
GeneratedFor Full block path for the generated function
BlockDescription User input from the Block Description parameter of the block

properties dialog box. BlockDescription contains an optional
token attribute, style. The only valid value forstyle is
content_only, which is case-sensitive and enclosed in double
quotes. Use the content_only style when you want to include
only the block description content that you entered in the block
parameter dialog. The syntax for the token attribute style is:

%<BlockDescription style = "content_only">

Shared Utility Function Banner

The shared utility function banner section contains comments and tokens for use in generating a
custom shared utility function banner. The shared utility function banner precedes C or C++ shared
utility function generated during the build process. If you omit the shared utility function banner
section from the CGT file, the default shared utility function banner emits to the generated code. The
following section is the default shared utility function banner section provided with the default CGT
file, matlabroot/toolbox/rtw/targets/ecoder/ert_code_template.cgt.
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom shared utility function banner section (optional)
%%   Customize banners for functions generated in shared location by using the
%% following predefined tokens: %<FunctionName>, %<FunctionDescription>,
%% %<Arguments>, %<ReturnType>.
%%
<SharedUtilityBanner style="classic">
%<FunctionDescription>
</SharedUtilityBanner>

Summary of Tokens for Shared Utility Function Banner Generation

FunctionName Name of function
Arguments List of function arguments
ReturnType Return type of function
FunctionDescription Short abstract about function

File Trailer

The file trailer section contains comments for generating a custom file trailer. The file trailer follows
C or C++ code generated from the model. If you omit the file trailer section from the CGT file, no file
trailer emits to the generated code. The following section is the default file trailer provided in the
default CGT file.
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom file trailer section (optional)
%%
<FileTrailer style="classic">
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File trailer for generated code.

[EOF]
</FileTrailer>

Tokens available for the file banner are available for the file trailer. See Summary of Tokens for File
Banner Generation.
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Template Symbols and Rules
In this section...
“Introduction” on page 53-77
“Template Symbol Groups” on page 53-77
“Template Symbols” on page 53-79
“Rules for Modifying or Creating a Template” on page 53-81

Introduction
“Template Symbol Groups” on page 53-77 and “Template Symbols” on page 53-79 describe custom
file processing (CFP) template symbols and rules for using them. The location of a symbol in one of
the supplied template files (code_c_template.cgt, code_h_template.cgt,
data_c_template.cgt, or data_h_template.cgt) determines where the items associated with
that symbol are located in the corresponding generated file. “Template Symbol Groups” on page 53-
77 identifies the symbol groups, starting with the parent (“Base”) group, followed by the children of
each parent. “Template Symbols” on page 53-79 lists the symbols alphabetically.

Note If you are using custom CGT sections, for files generated to the _sharedutils folder, you can
only use symbol names in the Base symbol group.

Template Symbol Groups
Symbol Group Symbol Names in This Group
Base (Parents) Declarations

Defines

Definitions

Documentation

Enums

Functions

Includes

Types
Declarations ExternalCalibrationLookup1D

ExternalCalibrationLookup2D

ExternalCalibrationScalar

ExternalVariableScalar
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Symbol Group Symbol Names in This Group
Defines LocalDefines

LocalMacros
Definitions FilescopeCalibrationLookup1D

FilescopeCalibrationLookup2D

FilescopeCalibrationScalar

FilescopeVariableScalar

GlobalCalibrationLookup1D

GlobalCalibrationLookup2D

GlobalCalibrationScalar

GlobalVariableScalar
Documentation Abstract

Banner

Created

Creator

Date

Description

FileName

History

LastModifiedDate

LastModifiedBy

ModelName

ModelVersion

ModifiedBy
 Notes

ToolVersion
Functions CFunctionCode
Types This parent has no children.
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Template Symbols
Symbol Name* Symbol Group Symbol

Scope
Symbol Description (What the
symbol puts in the generated
file)

Abstract Documentation N/A User-supplied description of the
model or file. Placed in the
generated file based on the
Stateflow note, Simulink
annotation, or DocBlock on the
model.**

Banner Documentation N/A Comments located near top of the
file. Contains information that
includes model and software
versions, and date file was
generated.

CFunctionCode Functions File C/C++ functions. Must be at the
bottom of the template.

Created Documentation N/A Date when model was created.
From Created on field on Model
Properties dialog box.

Creator Documentation N/A User who created model. From
Created by field on Model
Properties dialog box.

Date Documentation N/A Date file was generated. Taken
from computer clock.

Declarations Base  Data declaration of a signal or
parameter. For example, extern
real_T globalvar;.

Defines Base File Required #defines of .h files.
Definitions Base File Data definitions of signals or

parameters.
Description Documentation N/A Description of model. From Model

description field on Model
Properties dialog box.**

Documentation Base N/A Comments about how to interpret
the generated files.

Enums Base File Enumerated data type definitions.
ExternalCalibrationLookup1D Declarations External ***
ExternalCalibrationLookup2D Declarations External ***
ExternalCalibrationScalar Declarations External ***
ExternalVariableScalar Declarations External ***
FileName Documentation N/A Name of the generated file.
FilescopeCalibrationLookup1D Definitions File ***
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Symbol Name* Symbol Group Symbol
Scope

Symbol Description (What the
symbol puts in the generated
file)

FilescopeCalibrationLookup2D Definitions File ***
FilescopeCalibrationScalar Definitions File ***
FilescopeVariableScalar Definitions File ***
Functions Base File Generated function code.
GlobalCalibrationLookup1D Definitions Global ***
GlobalCalibrationLookup2D Definitions Global ***
GlobalCalibrationScalar Definitions Global ***
GlobalVariableScalar Definitions Global ***
History Documentation N/A User-supplied revision history of

the generated files. Placed in the
generated file based on the
Stateflow note, Simulink
annotation, or DocBlock on the
model.**

Includes Base File #include preprocessor directives.
LastModifiedDate Documentation N/A Date when model was last saved.

From Last saved on field on Model
Properties dialog box.

LastModifiedBy Documentation N/A User who last saved model. From
Last saved by field on Model
Properties dialog box.

LocalDefines Defines File #define preprocessor directives
from code-generation data objects.

LocalMacros Defines File C/C++ macros local to the file.
ModelName Documentation N/A Name of the model.
ModelVersion Documentation N/A Number incremented by 1 each

time you save the model.
ModifiedBy Documentation N/A Name of user who last modified the

model.
Notes Documentation N/A User-supplied miscellaneous notes

about the model or generated files.
Placed in the generated file based
on the Stateflow note, Simulink
annotation, or DocBlock on the
model.**

ToolVersion Documentation N/A A list of the versions of the
toolboxes used in generating the
code.

Types Base  Data types of generated code.

* Symbol names must be enclosed between %< >. For example, %<Functions>.
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** This symbol can be used to add a comment to the generated files. See “Add Global Comments in
the Generated Code” on page 53-5. The code generator places the comment in each generated file
whose template has this symbol name. The code generator places the comment at the location that
corresponds to where the symbol name is located in the template file.

*** The description can be deduced from the symbol name. For example,
GlobalCalibrationScalar is a symbol that identifies a scalar. It contains data of global scope that
you can calibrate.

Rules for Modifying or Creating a Template
The following are the rules for creating an MPF template. “Comparison of a Template and Its
Generated File” on page 53-64 illustrates several of these rules.

1 Place a symbol on a template within the %< > delimiter. For example, the symbol named
Includes should look like this on a template: %<Includes>. Note that symbol names are case-
sensitive.

2 Place a symbol on a template where desired. Its location on the template determines where the
item associated with this symbol is located in the generated file. If no item is associated with it,
the symbol is ignored.

3 Place a C/C++ statement outside of the %< > delimiter, and on a different line than a %< >
delimiter, for that statement to appear in the generated file. For example, #pragma message
("my text") in the template results in #pragma message ("my text") at the corresponding
location in the generated file. Note that the statement must be compatible with your C/C++
compiler.

4 Use the .cgt extension for every template filename. ("cgt" stands for code generation
template.)

5 Note that %% $Revision: 1.1.4.10.4.1 $ appears at the top of the MathWorks supplied
templates. This is for internal MathWorks use only. It does not need to be placed on a user-
defined template and does not show in a generated file.

6 Place a comment on the template between /* */ as in standard ANSI C7. This results in /
*comment*/ on the generated file.

7 Each MPF template must have all of the Base group symbols, in predefined order. They are listed
in “Template Symbol Groups” on page 53-77. Each symbol in the Base group is a parent. For
example, Declarations is a parent symbol.

8 Each symbol in a non-Base group is a child. For example, LocalMacros is a child.
9 Except for Documentation children, children must be placed after their parent, before the next

parent, and before the Functions symbol.
10 Documentation children can be located before or after their parent in any order anywhere in the

template.
11 If a non-Documentation child is missing from the template, the code generator places the

information associated with this child at its parent location in the generated file.
12 If a Documentation child is missing from the template, the code generator omits the information

associated with that child from the generated file.

7. ANSI is a registered trademark of the American National Standards Institute, Inc.
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Annotate Code for Justifying Polyspace Checks
This example shows how to turn on comments in the generated code that suppress error detection
through Polyspace.

Polyspace Checks

With the Polyspace Code Prover software you can apply Polyspace verification to Embedded Coder
generated code. The software detects run-time errors in the generated code and helps you to locate
and fix model faults. Polyspace might highlight overflows for certain operations that are legitimate
because of the way the code generator implements these operations. These legitimate overflows
should not be flagged by Polyspace. Generate comments in the code that suppress this error
detection.

Code Generation

1. Open the example Simulink model mSatAddSub.

model='mSatAddSub';
open_system(model);

2. In the Embedded Coder app on the Configuration Parameters dialog box, turn off Operator
annotations.

set_param('mSatAddSub','OperatorAnnotations','off');

3. To build the model and generate code, press Ctrl+B.

evalc('slbuild(''mSatAddSub'')');

%The generated code is:
file = fullfile('mSatAddSub_ert_rtw','mSatAddSub.c');
rtwdemodbtype(file,'/* Model step function */',...
    'End of Sum',1,1);

/* Model step function */
void mSatAddSub_step(void)
{
  uint32_T qY;

  /* Sum: '<Root>/SubUnsigned' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   */
  qY = U1 - U2;
  if (qY > U1) {
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    qY = 0U;
  }

  /* Sum: '<Root>/SubUnsigned' */
  USub = qY;

  /* Outport: '<Root>/Out3' */
  mSatAddSub_Y.Out3 = USub;

  /* Matfile logging */
  rt_UpdateTXYLogVars(mSatAddSub_M->rtwLogInfo, (&mSatAddSub_M->Timing.taskTime0));

  /* signal main to stop simulation */
  {                                    /* Sample time: [1.0s, 0.0s] */
    if ((rtmGetTFinal(mSatAddSub_M)!=-1) &&
        !((rtmGetTFinal(mSatAddSub_M)-mSatAddSub_M->Timing.taskTime0) >
          mSatAddSub_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(mSatAddSub_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   */
  mSatAddSub_M->Timing.taskTime0 =
    ((time_T)(++mSatAddSub_M->Timing.clockTick0)) *
    mSatAddSub_M->Timing.stepSize0;
}

/* Model initialize function */
void mSatAddSub_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)mSatAddSub_M, 0,
                sizeof(RT_MODEL_mSatAddSub));
  rtmSetTFinal(mSatAddSub_M, 1.0);
  mSatAddSub_M->Timing.stepSize0 = 1.0;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    mSatAddSub_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(mSatAddSub_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(mSatAddSub_M->rtwLogInfo, (NULL));
    rtliSetLogT(mSatAddSub_M->rtwLogInfo, "tout");
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    rtliSetLogX(mSatAddSub_M->rtwLogInfo, "");
    rtliSetLogXFinal(mSatAddSub_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(mSatAddSub_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(mSatAddSub_M->rtwLogInfo, 1);
    rtliSetLogMaxRows(mSatAddSub_M->rtwLogInfo, 1000);
    rtliSetLogDecimation(mSatAddSub_M->rtwLogInfo, 1);

    /*
     * Set pointers to the data and signal info for each output
     */
    {
      static void * rt_LoggedOutputSignalPtrs[] = {
        &mSatAddSub_Y.Out3
      };

      rtliSetLogYSignalPtrs(mSatAddSub_M->rtwLogInfo, ((LogSignalPtrsType)
        rt_LoggedOutputSignalPtrs));
    }

    {
      static int_T rt_LoggedOutputWidths[] = {
        1
      };

      static int_T rt_LoggedOutputNumDimensions[] = {
        1
      };

      static int_T rt_LoggedOutputDimensions[] = {
        1
      };

      static boolean_T rt_LoggedOutputIsVarDims[] = {
        0
      };

      static void* rt_LoggedCurrentSignalDimensions[] = {
        (NULL)
      };

      static int_T rt_LoggedCurrentSignalDimensionsSize[] = {
        4
      };

      static BuiltInDTypeId rt_LoggedOutputDataTypeIds[] = {
        SS_UINT32
      };

      static int_T rt_LoggedOutputComplexSignals[] = {
        0
      };

      static RTWPreprocessingFcnPtr rt_LoggingPreprocessingFcnPtrs[] = {
        (NULL)
      };

      static const char_T *rt_LoggedOutputLabels[] = {
        "USub" };
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      static const char_T *rt_LoggedOutputBlockNames[] = {
        "mSatAddSub/Out3" };

      static RTWLogDataTypeConvert rt_RTWLogDataTypeConvert[] = {
        { 0, SS_UINT32, SS_UINT32, 0, 0, 0, 1.0, 0, 0.0 }
      };

      static RTWLogSignalInfo rt_LoggedOutputSignalInfo[] = {
        {
          1,
          rt_LoggedOutputWidths,
          rt_LoggedOutputNumDimensions,
          rt_LoggedOutputDimensions,
          rt_LoggedOutputIsVarDims,
          rt_LoggedCurrentSignalDimensions,
          rt_LoggedCurrentSignalDimensionsSize,
          rt_LoggedOutputDataTypeIds,
          rt_LoggedOutputComplexSignals,
          (NULL),
          rt_LoggingPreprocessingFcnPtrs,

          { rt_LoggedOutputLabels },
          (NULL),
          (NULL),
          (NULL),

          { rt_LoggedOutputBlockNames },

          { (NULL) },
          (NULL),
          rt_RTWLogDataTypeConvert
        }
      };

      rtliSetLogYSignalInfo(mSatAddSub_M->rtwLogInfo, rt_LoggedOutputSignalInfo);

      /* set currSigDims field */
      rt_LoggedCurrentSignalDimensions[0] = &rt_LoggedOutputWidths[0];
    }

    rtliSetLogY(mSatAddSub_M->rtwLogInfo, "yout");
  }

  /* block I/O */

  /* exported global signals */
  USub = 0U;

  /* external inputs */
  U1 = 0U;
  U2 = 0U;

  /* external outputs */
  mSatAddSub_Y.Out3 = 0U;

  /* Matfile logging */
  rt_StartDataLoggingWithStartTime(mSatAddSub_M->rtwLogInfo, 0.0, rtmGetTFinal
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    (mSatAddSub_M), mSatAddSub_M->Timing.stepSize0, (&rtmGetErrorStatus
    (mSatAddSub_M)));
}

/* Model terminate function */
void mSatAddSub_terminate(void)
{
  /* (no terminate code required) */
}

/*
 * File trailer for generated code.
 *
 * [EOF]
 */

4. Run the Polyspace check. The code generator recognizes that the largest built-in data type is 32-
bit. It is not possible to saturate all the results of the subtractions using 0U and a bigger single-word
integer data type. Instead the software detects the results overflow and the direction of the overflow,
and saturates the result. The operation is flagged by Polyspace because it fails to recognize the
saturation.

5. In the Embedded Coder app on the Configuration Parameters dialog box, turn off Operator
annotations.

set_param('mSatAddSub','OperatorAnnotations',"on");
evalc('slbuild(''mSatAddSub'')');

6. The generated code is:

file = fullfile('mSatAddSub_ert_rtw','mSatAddSub.c');
rtwdemodbtype(file,'/* Model step function */',...
    'End of Sum',1,1);

/* Model step function */
void mSatAddSub_step(void)
{
  uint32_T qY;

  /* Sum: '<Root>/SubUnsigned' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   */
  qY = U1 - /*MW:OvSatOk*/ U2;
  if (qY > U1) {
    qY = 0U;
  }

  /* Sum: '<Root>/SubUnsigned' */
  USub = qY;

  /* Outport: '<Root>/Out3' */
  mSatAddSub_Y.Out3 = USub;

  /* Matfile logging */
  rt_UpdateTXYLogVars(mSatAddSub_M->rtwLogInfo, (&mSatAddSub_M->Timing.taskTime0));
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  /* signal main to stop simulation */
  {                                    /* Sample time: [1.0s, 0.0s] */
    if ((rtmGetTFinal(mSatAddSub_M)!=-1) &&
        !((rtmGetTFinal(mSatAddSub_M)-mSatAddSub_M->Timing.taskTime0) >
          mSatAddSub_M->Timing.taskTime0 * (DBL_EPSILON))) {
      rtmSetErrorStatus(mSatAddSub_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   */
  mSatAddSub_M->Timing.taskTime0 =
    ((time_T)(++mSatAddSub_M->Timing.clockTick0)) *
    mSatAddSub_M->Timing.stepSize0;
}

/* Model initialize function */
void mSatAddSub_initialize(void)
{
  /* Registration code */

  /* initialize non-finites */
  rt_InitInfAndNaN(sizeof(real_T));

  /* initialize real-time model */
  (void) memset((void *)mSatAddSub_M, 0,
                sizeof(RT_MODEL_mSatAddSub));
  rtmSetTFinal(mSatAddSub_M, 1.0);
  mSatAddSub_M->Timing.stepSize0 = 1.0;

  /* Setup for data logging */
  {
    static RTWLogInfo rt_DataLoggingInfo;
    rt_DataLoggingInfo.loggingInterval = (NULL);
    mSatAddSub_M->rtwLogInfo = &rt_DataLoggingInfo;
  }

  /* Setup for data logging */
  {
    rtliSetLogXSignalInfo(mSatAddSub_M->rtwLogInfo, (NULL));
    rtliSetLogXSignalPtrs(mSatAddSub_M->rtwLogInfo, (NULL));
    rtliSetLogT(mSatAddSub_M->rtwLogInfo, "tout");
    rtliSetLogX(mSatAddSub_M->rtwLogInfo, "");
    rtliSetLogXFinal(mSatAddSub_M->rtwLogInfo, "");
    rtliSetLogVarNameModifier(mSatAddSub_M->rtwLogInfo, "rt_");
    rtliSetLogFormat(mSatAddSub_M->rtwLogInfo, 1);
    rtliSetLogMaxRows(mSatAddSub_M->rtwLogInfo, 1000);
    rtliSetLogDecimation(mSatAddSub_M->rtwLogInfo, 1);

    /*
     * Set pointers to the data and signal info for each output
     */
    {
      static void * rt_LoggedOutputSignalPtrs[] = {
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        &mSatAddSub_Y.Out3
      };

      rtliSetLogYSignalPtrs(mSatAddSub_M->rtwLogInfo, ((LogSignalPtrsType)
        rt_LoggedOutputSignalPtrs));
    }

    {
      static int_T rt_LoggedOutputWidths[] = {
        1
      };

      static int_T rt_LoggedOutputNumDimensions[] = {
        1
      };

      static int_T rt_LoggedOutputDimensions[] = {
        1
      };

      static boolean_T rt_LoggedOutputIsVarDims[] = {
        0
      };

      static void* rt_LoggedCurrentSignalDimensions[] = {
        (NULL)
      };

      static int_T rt_LoggedCurrentSignalDimensionsSize[] = {
        4
      };

      static BuiltInDTypeId rt_LoggedOutputDataTypeIds[] = {
        SS_UINT32
      };

      static int_T rt_LoggedOutputComplexSignals[] = {
        0
      };

      static RTWPreprocessingFcnPtr rt_LoggingPreprocessingFcnPtrs[] = {
        (NULL)
      };

      static const char_T *rt_LoggedOutputLabels[] = {
        "USub" };

      static const char_T *rt_LoggedOutputBlockNames[] = {
        "mSatAddSub/Out3" };

      static RTWLogDataTypeConvert rt_RTWLogDataTypeConvert[] = {
        { 0, SS_UINT32, SS_UINT32, 0, 0, 0, 1.0, 0, 0.0 }
      };

      static RTWLogSignalInfo rt_LoggedOutputSignalInfo[] = {
        {
          1,
          rt_LoggedOutputWidths,
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          rt_LoggedOutputNumDimensions,
          rt_LoggedOutputDimensions,
          rt_LoggedOutputIsVarDims,
          rt_LoggedCurrentSignalDimensions,
          rt_LoggedCurrentSignalDimensionsSize,
          rt_LoggedOutputDataTypeIds,
          rt_LoggedOutputComplexSignals,
          (NULL),
          rt_LoggingPreprocessingFcnPtrs,

          { rt_LoggedOutputLabels },
          (NULL),
          (NULL),
          (NULL),

          { rt_LoggedOutputBlockNames },

          { (NULL) },
          (NULL),
          rt_RTWLogDataTypeConvert
        }
      };

      rtliSetLogYSignalInfo(mSatAddSub_M->rtwLogInfo, rt_LoggedOutputSignalInfo);

      /* set currSigDims field */
      rt_LoggedCurrentSignalDimensions[0] = &rt_LoggedOutputWidths[0];
    }

    rtliSetLogY(mSatAddSub_M->rtwLogInfo, "yout");
  }

  /* block I/O */

  /* exported global signals */
  USub = 0U;

  /* external inputs */
  U1 = 0U;
  U2 = 0U;

  /* external outputs */
  mSatAddSub_Y.Out3 = 0U;

  /* Matfile logging */
  rt_StartDataLoggingWithStartTime(mSatAddSub_M->rtwLogInfo, 0.0, rtmGetTFinal
    (mSatAddSub_M), mSatAddSub_M->Timing.stepSize0, (&rtmGetErrorStatus
    (mSatAddSub_M)));
}

/* Model terminate function */
void mSatAddSub_terminate(void)
{
  /* (no terminate code required) */
}

/*
 * File trailer for generated code.

 Annotate Code for Justifying Polyspace Checks

53-89



 *
 * [EOF]
 */

The code generator inserts the /*MW:OvSatOk*/ comment that suppresses the error detected by
Polyspace.

7. Close the model.

bdclose(model)
rtwdemoclean;

See Also

Related Examples
• “Model Configuration Parameters: Comments”
• “Run Polyspace Analysis on Code Generated with Embedded Coder” (Polyspace Bug Finder)
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Enhance Readability of Code for Flow Charts
In this section...
“Appearance of Generated Code for Flow Charts” on page 53-91
“Convert If-Elseif-Else Code to Switch-Case Statements” on page 53-93
“Example of Converting Code to Switch-Case Statements” on page 53-95

Appearance of Generated Code for Flow Charts
If you have Embedded Coder and you generate code for models that include Stateflow objects, the
code from a flow chart resembles the samples that follow.

The following characteristics apply:

• By default, the generated code uses if-elseif-else statements to represent switch patterns.
To convert the code to use switch-case statements, see “Convert If-Elseif-Else Code to Switch-
Case Statements” on page 53-93.

• By default, variables that appear in the flow chart do not retain their names in the generated code.
Modified identifiers make sure that no naming conflicts occur.

• Traceability comments for the transitions appear between each set of /* and */ markers. To learn
more about traceability, see “Trace Stateflow Elements in Generated Code” on page 77-12.

if (modelname_U.In1 == 1.0) {
  /* Transition: '<S1>:11' */
  /* Transition: '<S1>:12' */
  modelname_Y.Out1 = 10.0;

  /* Transition: '<S1>:15' */
  /* Transition: '<S1>:16' */
} else {
  /* Transition: '<S1>:10' */
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  if (modelname_U.In1 == 2.0) {
    /* Transition: '<S1>:13' */
    /* Transition: '<S1>:14' */
    modelname_Y.Out1 = 20.0;

    /* Transition: '<S1>:16' */
  } else {
    /* Transition: '<S1>:17' */
    modelname_Y.Out1 = 30.0;
  }
}

Sample Code for a Decision Logic Pattern

for (sf_i = 0; sf_i < 10; sf_i++) {
  /* Transition: '<S1>:40' */
  /* Transition: '<S1>:41' */
  modelname_B.y = modelname_B.y +
    modelname_U.In1;

  /* Transition: '<S1>:39' */
}

Sample Code for an Iterative Loop Pattern
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if (modelname_U.In1 == 1.0) {
  /* Transition: '<S1>:149' */
  /* Transition: '<S1>:150' */
  modelname_Y.Out1 = 1.0;

  /* Transition: '<S1>:151' */
  /* Transition: '<S1>:152' */
  /* Transition: '<S1>:158' */
  /* Transition: '<S1>:159' */
} else {
  /* Transition: '<S1>:156' */
  if (modelname_U.In1 == 2.0) {
    /* Transition: '<S1>:153' */
    /* Transition: '<S1>:154' */
    modelname_Y.Out1 = 2.0;

    /* Transition: '<S1>:155' */
    /* Transition: '<S1>:158' */
    /* Transition: '<S1>:159' */
  } else {
    /* Transition: '<S1>:161' */
    modelname_Y.Out1 = 3.0;
  }
}

Sample Code for a Switch Pattern

Convert If-Elseif-Else Code to Switch-Case Statements
When you generate code for embedded real-time targets, you can choose to convert if-elseif-
else code to switch-case statements. This conversion can enhance readability of the code. For
example, when a flow chart contains a long list of conditions, the switch-case structure:

• Reduces the use of parentheses and braces
• Minimizes repetition in the generated code

How to Convert If-Elseif-Else Code to Switch-Case Statements

Step Task Reference
1 Verify that your flow chart follows the rules

for conversion.
“Verify the Contents of the Flow Chart” on
page 53-96

2 Enable the conversion and generate code for
your model.

“Enable the Conversion” on page 53-97

3 Troubleshoot the generated code.

• If you see switch-case statements for
your flow chart, you can stop.

• If you see if-elseif-else statements
for your flow chart, update the chart and
repeat the previous step.

“Troubleshoot the Generated Code” on page
53-97
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Rules of Conversion

For the conversion to occur, following these guidelines. LHS and RHS refer to the left-hand side and
right-hand side of a condition, respectively.

Construct Rules to Follow
Flow chart Must have a default and two or more unique conditions.

For more information, see “Duplicate Conditions” on page 53-94.
Each condition Must test equality only.

Must use the same variable or expression for the LHS. You can reverse the LHS
and RHS.

Each LHS Must be a single variable or expression.
Cannot be a constant.
Must have an integer or enumerated data type.
Cannot have any side effects on simulation.

For example, the LHS can read from but not write to global variables.
Each RHS Must be a constant or a parameter.

Must have an integer or enumerated data type.

Duplicate Conditions

If a flow chart has duplicate conditions, the conversion preserves only the first condition. The code
discards the other instances of duplicate conditions.

After removal of duplicates, two or more unique conditions must exist. If not, the conversion does not
occur and the code contains all duplicate conditions.

Example of Generated Code Code After Conversion
if (x == 1) {
    block1
} else if (x == 2) {
    block2
} else if (x == 1) {  // duplicate
    block3
} else if (x == 3) {
    block4
} else if (x == 1) {  // duplicate
    block5
} else {
    block6
}

switch (x) {
    case 1:  
     block1; break;
    case 2:  
     block2; break;
    case 3:  
     block4; break;
    default: 
     block6; break;
}

if (x == 1) {
    block1
} else if (x == 1) {  // duplicate
    block2
} else {
    block3
}

No change, because only one unique
condition exists
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Example of Converting Code to Switch-Case Statements
Suppose that you have this model containing a single chart.

The chart contains a flow chart and four MATLAB functions.

The MATLAB functions in the chart contain the code listed in the table. In each case, the Function
Inline Option is Auto. For more information about function inlining, see “Specify Properties of
Graphical Functions” (Stateflow).

MATLAB Function Code
stop function stop

%#codegen
coder.extrinsic('disp');
disp('Not moving.')

traffic_speed = 0;

slowdown function slowdown
%#codegen
coder.extrinsic('disp')
disp('Slowing down.')

traffic_speed = 1;
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MATLAB Function Code
accelerate function accelerate

%#codegen
coder.extrinsic('disp');
disp('Moving along.')

traffic_speed = 2;

light function color = light(x)
%#codegen
if (x < 20)
    color = TrafficLights.GREEN;
elseif (x >= 20 && x < 25)
    color = TrafficLights.YELLOW;
else
    color = TrafficLights.RED;
end

The output color of the function light uses the enumerated type TrafficLights. The
enumerated type definition in TrafficLights.m is:

classdef TrafficLights < Simulink.IntEnumType
  enumeration
    RED(0)
    YELLOW(5)
    GREEN(10)
  end
end

For more information, see “Define Enumerated Data Types” (Stateflow).

Verify the Contents of the Flow Chart

Check that the flow chart in your Stateflow chart follows the rules in “Rules of Conversion” on page
53-94.

Construct How the Construct Follows the Rules
Flow chart A default condition and two unique conditions exist:

• [light(intersection) == RED]
• [light(intersection) == YELLOW]

Each condition Each condition:

• Tests equality
• Uses the same function call light(intersection) for the LHS

Each LHS Each LHS:

• Contains a single expression
• Is the output of a function call, not a constant
• Is of enumerated type TrafficLights, which you define in

TrafficLights.m on the MATLAB path. See “Define Enumerated Data
Types” (Stateflow).

• Uses a function call that does not have side effects
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Construct How the Construct Follows the Rules
Each RHS Each RHS:

• Is an enumerated value and therefore a constant
• Is of enumerated type TrafficLights

Enable the Conversion

1 Open the Model Configuration Parameters dialog box.
2 In the Code Generation pane, select ert.tlc for the System target file for an ERT-based

target for your model.
3 In the Code Generation > Code Style pane, select the Convert if-elseif-else patterns to

switch-case statements check box.

If you select this check box, the conversion applies to:

• Flow charts in all charts of a model
• MATLAB functions in all charts of a model
• All MATLAB Function blocks in that model

4 In the model, on the C Code tab, click Build to generate source code from the model.

Troubleshoot the Generated Code

The generated code for the flow chart appears like this code:

if (sf_color == RED) {
  /* Transition: '<S1>:11' */
  /* Transition: '<S1>:12' */
  /* MATLAB Function 'stop': '<S1>:23' */
  /* '<S1>:23:6' */
  rtb_traffic_speed = 0;

  /* Transition: '<S1>:15' */
  /* Transition: '<S1>:16' */
} else {
  /* Transition: '<S1>:10' */
  /* MATLAB Function 'light': '<S1>:19' */
  if (ifelse_using_enums_U.In1 < 20.0) {
    /* '<S1>:19:3' */
    /* '<S1>:19:4' */
    sf_color = GREEN;
  } else if ((ifelse_using_enums_U.In1 >= 20.0) && 
             (ifelse_using_enums_U.In1 < 25.0)) {
    /* '<S1>:19:5' */
    /* '<S1>:19:6' */
    sf_color = YELLOW;
  } else {
    /* '<S1>:19:8' */
    sf_color = RED;
  }

  if (sf_color == YELLOW) {
    /* Transition: '<S1>:13' */
    /* Transition: '<S1>:14' */
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    /* MATLAB Function 'slowdown': '<S1>:24' */
    /* '<S1>:24:6' */
    rtb_traffic_speed = 1;

    /* Transition: '<S1>:16' */
  } else {
    /* Transition: '<S1>:17' */
    /* MATLAB Function 'accelerate': '<S1>:25' */
    /* '<S1>:25:6' */
    rtb_traffic_speed = 2;
  }
}

Because the MATLAB function light appears inlined, inequality comparisons appear in these lines of
code:

if (ifelse_using_enums_U.In1 < 20.0) {
....
} else if ((ifelse_using_enums_U.In1 >= 20.0) && 
             (ifelse_using_enums_U.In1 < 25.0)) {
....

Because inequalities appear in the body of the if-elseif-else code for the flow chart, the
conversion to switch-case statements does not occur. Do one of the following:

• Specify that the function light does not appear inlined. See “Change the Inlining Property for
the Function” on page 53-98.

• Modify the flow chart. See “Modify the Flow Chart to Ensure Switch-Case Statements” on page
53-99.

Change the Inlining Property for the Function

If you do not want to modify your flow chart, change the inlining property for the function light:

1 Right-click the function box for light and select Properties.
2 In the properties dialog box, for Function Inline Option, select Function.
3 Click OK to close the dialog box.

Note You do not have to change the inlining property for the other three MATLAB functions in the
chart. Because the flow chart does not call those functions during evaluation of conditions, the
inlining property for those functions can remain Auto.

When you regenerate code for your model, the code for the flow chart now appears like this code:

switch (ifelse_using_enums_light(ifelse_using_enums_U.In1)) {
 case RED:
  /* Transition: '<S1>:11' */
  /* Transition: '<S1>:12' */
  /* MATLAB Function 'stop': '<S1>:23' */
  /* '<S1>:23:6' */
  ifelse_using_enums_Y.Out1 = 0.0;

  /* Transition: '<S1>:15' */
  /* Transition: '<S1>:16' */

53 Code Appearance in Embedded Coder

53-98



  break;

 case YELLOW:
  /* Transition: '<S1>:10' */
  /* Transition: '<S1>:13' */
  /* Transition: '<S1>:14' */
  /* MATLAB Function 'slowdown': '<S1>:24' */
  /* '<S1>:24:6' */
  ifelse_using_enums_Y.Out1 = 1.0;

  /* Transition: '<S1>:16' */
  break;

 default:
  /* Transition: '<S1>:17' */
  /* MATLAB Function 'accelerate': '<S1>:25' */
  /* '<S1>:25:6' */
  ifelse_using_enums_Y.Out1 = 2.0;
  break;
}

Because the MATLAB function light no longer appears inlined, the conversion to switch-case
statements occurs. To enhance readability, the switch-case statements provide these benefits:

• The code reduces the use of parentheses and braces.
• The LHS expression ifelse_using_enums_light(ifelse_using_enums_U.In1) appears

only once, minimizing repetition in the code.

Modify the Flow Chart to Ensure Switch-Case Statements

If you do not want to change the inlining property for the function light, modify your flow chart:

1 Add chart local data color_out with the enumerated type TrafficLights.
2 Replace each instance of light(intersection) with color_out.
3 Add the action {color_out = light(intersection)} to the default transition of the flow

chart.

The chart now looks similar to this chart:
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When you regenerate code for your model, the code for the flow chart uses switch-case
statements.

See Also

More About
• “Model Configuration Parameters: Code Style”
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Enhance Code Readability for MATLAB Function Blocks

In this section...
“Requirements for Using Readability Optimizations” on page 53-101
“Converting If-Elseif-Else Code to Switch-Case Statements” on page 53-101
“Example of Converting Code for If-Elseif-Else Decision Logic to Switch-Case Statements” on page
53-103

Requirements for Using Readability Optimizations
To use readability optimizations in your code, you must have an Embedded Coder license. These
optimizations appear only in code that you generate for an embedded real-time (ert) target.

Note These optimizations do not apply to MATLAB files that you call from the MATLAB Function
block.

For more information, see “Configure a System Target File” on page 48-2.

Converting If-Elseif-Else Code to Switch-Case Statements
When you generate code for embedded real-time targets, you can choose to convert if-elseif-
else decision logic to switch-case statements. This conversion can enhance readability of the
code.

For example, when a MATLAB Function block contains a long list of conditions, the switch-case
structure:

• Reduces the use of parentheses and braces
• Minimizes repetition in the generated code

How to Convert If-Elseif-Else Code to Switch-Case Statements

The following procedure describes how to convert generated code for the MATLAB Function block
from if-elseif-else to switch-case statements.

Step Task Reference
1 Verify that your block follows the rules for

conversion.
“Verifying the Contents of the Block” on
page 53-104

2 Enable the conversion. “Enabling the Conversion” on page 53-105
3 Generate code for your model. “Generating Code for Your Model” on page

53-105

Rules for Conversion

For the conversion to occur, the following rules must hold. LHS and RHS refer to the left-hand side
and right-hand side of a condition, respectively.
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Construct Rules to Follow
MATLAB Function block Must have two or more unique conditions, in addition to a default.

For more information, see “How the Conversion Handles Duplicate
Conditions” on page 53-102.

Each condition Must test equality only.
Must use the same variable or expression for the LHS.

Note You can reverse the LHS and RHS.
Each LHS Must be a single variable or expression, not a compound statement.

Cannot be a constant.
Must have an integer or enumerated data type.
Must not have side effects on simulation.

For example, the LHS can read from but not write to global variables.
Each RHS Must be a constant.

Must have an integer or enumerated data type.

How the Conversion Handles Duplicate Conditions

If a MATLAB Function block has duplicate conditions, the conversion preserves only the first
condition. The generated code discards other instances of duplicate conditions.

After removal of duplicates, two or more unique conditions must exist. Otherwise, a conversion does
not occur and the generated code contains instances of duplicate conditions.

The following examples show how the conversion handles duplicate conditions.

Example of Generated Code Code After Conversion
if (x == 1) {
    block1
} else if (x == 2) {
    block2
} else if (x == 1) {  // duplicate
    block3
} else if (x == 3) {
    block4
} else if (x == 1) {  // duplicate
    block5
} else {
    block6
}

switch (x) {
    case 1:  
     block1; break;
    case 2:  
     block2; break;
    case 3:  
     block4; break;
    default: 
     block6; break;
}

if (x == 1) {
    block1
} else if (x == 1) {  // duplicate
    block2
} else {
    block3
}

Does not change, because only one
unique condition exists
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Example of Converting Code for If-Elseif-Else Decision Logic to Switch-
Case Statements
Suppose that you have the following model with a MATLAB Function block. Assume that the output
data type is double and the input data type is Controller, an enumerated type that you define.

The block contains the following code:

function system = fcn(type)
%#codegen

if (type == Controller.P)
    system = 0;
elseif (type == Controller.I)
    system = 1;
elseif (type == Controller.PD)
    system = 2; 
elseif (type == Controller.PI)
    system = 3;
elseif (type == Controller.PID)
    system = 4;
else 
    system = 10;
end

The enumerated type definition in Controller.m is:

classdef Controller < Simulink.IntEnumType
  enumeration
    P(0)
    I(1)
    PD(2)
    PI(3)
    PID(4)
    UNKNOWN(10)
  end
end

If you generate code for an embedded real-time target using default settings, you see something like
this:

if (if_to_switch_eml_blocks_U.In1 == P) {
  /* '<S1>:1:4' */
  /* '<S1>:1:5' */
  if_to_switch_eml_blocks_Y.Out1 = 0.0;
} else if (if_to_switch_eml_blocks_U.In1 == I) {
  /* '<S1>:1:6' */
  /* '<S1>:1:7' */
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  if_to_switch_eml_blocks_Y.Out1 = 1.0;
} else if (if_to_switch_eml_blocks_U.In1 == PD) {
  /* '<S1>:1:8' */
  /* '<S1>:1:9' */
  if_to_switch_eml_blocks_Y.Out1 = 2.0;
} else if (if_to_switch_eml_blocks_U.In1 == PI) {
  /* '<S1>:1:10' */
  /* '<S1>:1:11' */
  if_to_switch_eml_blocks_Y.Out1 = 3.0;
} else if (if_to_switch_eml_blocks_U.In1 == PID) {
  /* '<S1>:1:12' */
  /* '<S1>:1:13' */
  if_to_switch_eml_blocks_Y.Out1 = 4.0;
} else {
  /* '<S1>:1:15' */
  if_to_switch_eml_blocks_Y.Out1 = 10.0;
}

The LHS variable if_to_switch_eml_blocks_U.In1 appears multiple times in the generated
code.

Note By default, variables that appear in the block do not retain their names in the generated code.
Modified identifiers prevent naming conflicts.

Traceability comments appear between each set of /* and */ markers. To learn more about
traceability, see “Use Traceability in MATLAB Function Blocks” on page 77-35.

Verifying the Contents of the Block

Check that the block follows the rules in “Rules for Conversion” on page 53-101.

Construct How the Construct Follows the Rules
MATLAB Function
block

Five unique conditions exist, in addition to the default:

• (type == Controller.P)
• (type == Controller.I)
• (type == Controller.PD)
• (type == Controller.PI)
• (type == Controller.PID)

Each condition Each condition:

• Tests equality
• Uses the same input for the LHS
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Construct How the Construct Follows the Rules
Each LHS Each LHS:

• Contains a single variable
• Is the input to the block and therefore not a constant
• Is of enumerated type Controller, which you define in Controller.m

on the MATLAB path
• Does not impact simulation

Each RHS Each RHS:

• Is an enumerated value and therefore a constant
• Is of enumerated type Controller

Enabling the Conversion

1 Open the Configuration Parameters dialog box.
2 In the Code Generation pane, select ert.tlc for the System target file.

This step specifies an embedded real-time target for your model.
3 In the Code Generation > Code Style pane, select the Convert if-elseif-else patterns to

switch-case statements check box.

Tip This conversion works on a per-model basis. If you select this check box, the conversion
applies to:

• MATLAB Function blocks in a model
• MATLAB functions in Stateflow charts of that model
• Flow charts in Stateflow charts of that model

For more information, see “Enhance Readability of Code for Flow Charts” on page 53-91.

Generating Code for Your Model

In the model window, press Ctrl+B.

The code for the MATLAB Function block uses switch-case statements instead of if-elseif-
else code:

switch (if_to_switch_eml_blocks_U.In1) {
 case P:
  /* '<S1>:1:4' */
  /* '<S1>:1:5' */
  if_to_switch_eml_blocks_Y.Out1 = 0.0;
  break;

 case I:
  /* '<S1>:1:6' */
  /* '<S1>:1:7' */
  if_to_switch_eml_blocks_Y.Out1 = 1.0;
  break;
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 case PD:
  /* '<S1>:1:8' */
  /* '<S1>:1:9' */
  if_to_switch_eml_blocks_Y.Out1 = 2.0;
  break;

 case PI:
  /* '<S1>:1:10' */
  /* '<S1>:1:11' */
  if_to_switch_eml_blocks_Y.Out1 = 3.0;
  break;

 case PID:
  /* '<S1>:1:12' */
  /* '<S1>:1:13' */
  if_to_switch_eml_blocks_Y.Out1 = 4.0;
  break;

 default:
  /* '<S1>:1:15' */
  if_to_switch_eml_blocks_Y.Out1 = 10.0;
  break;
}

The switch-case statements provide the following benefits to enhance readability:

• The code reduces the use of parentheses and braces.
• The LHS variable if_to_switch_eml_blocks_U.In1 appears only once, minimizing repetition

in the code.

See Also

More About
• “Use Traceability in MATLAB Function Blocks” on page 77-35
• “Code Generation for Enumerations”
• “Model Configuration Parameters: Code Style”
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Improve Data Coherency in Generated Code
For models containing read and write operations for Data Store Memory blocks, you can generate
code that contains a single variable to hold the value for each Data Store Read and Write operation.
Generating one variable for each operation improves data access coherency.

Example Model
The data_store_latching model contains a single Data Store Memory block that is accessed by
two different Data Store Memory Read and two Data Store Memory Write blocks. Two Sum blocks
perform addition on the input generated by the Data Store Read blocks and output the data to the
Data Store Write blocks .

Generate Code Without Parameter Enabled
Building the model with the Implement each data store block as a unique access point
parameter turned off by default, generates this code:

void data_store_latching_step(void)
    {
      /* DataStoreWrite: '<Root>/Data Store Write' incorporates:
       *  DataStoreRead: '<Root>/Data Store Read'
       *  Sum: '<Root>/Add'
       */
      data_store_latching_DW.A += data_store_latching_DW.A +
        data_store_latching_DW.A;
    
      /* DataStoreWrite: '<Root>/Data Store Write1' incorporates:
       *  DataStoreRead: '<Root>/Data Store Read1'
       *  Sum: '<Root>/Add1'
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       */
      data_store_latching_DW.A += data_store_latching_DW.A +
        data_store_latching_DW.A;
    }

For both data read and write operations, the code contains the global variable
data_store_latching_DW.A.

Generate Code With Parameter Enabled
In the Configuration Parameters dialog box, on the Interface pane, select the Implement each data
store block as a unique access point parameter. Click Apply.

The generated code is now:
void data_store_latching_step(void)
    {
      real_T rtb_DataStoreRead;
      real_T rtb_DataStoreRead1;
    
      /* DataStoreRead: '<Root>/Data Store Read' */
      rtb_DataStoreRead = data_store_latching_DW.A;
    
      /* DataStoreWrite: '<Root>/Data Store Write' incorporates:
       *  Sum: '<Root>/Add'
       */
      data_store_latching_DW.A = (rtb_DataStoreRead + rtb_DataStoreRead) +
        rtb_DataStoreRead;
    
      /* DataStoreRead: '<Root>/Data Store Read1' */
      rtb_DataStoreRead1 = data_store_latching_DW.A;
    
      /* DataStoreWrite: '<Root>/Data Store Write1' incorporates:
       *  Sum: '<Root>/Add1'
       */
      data_store_latching_DW.A = (rtb_DataStoreRead1 + rtb_DataStoreRead1) +
        rtb_DataStoreRead1;
    }

For each data store read operation, the code contains a variable. The variables are
rtb_DataStoreRead and rtb_DataStoreRead1. These separate variables improve data access
coherency.

See Also

More About
• “Data Stores in Generated Code”
• “Data Stores”
• “Implement each data store block as a unique access point”
• “Model Configuration Parameters: Code Style”
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Code Replacement in Simulink Coder

• “What Is Code Replacement?” on page 54-2
• “Choose a Code Replacement Library” on page 54-6
• “Replace Code Generated from Simulink Models” on page 54-8
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What Is Code Replacement?
Code replacement is a technique to change the code that the code generator produces for functions
and operators to meet application code requirements. For example, you can replace generated code
to meet requirements such as:

• Optimization for a specific run-time environment, including, but not limited to, specific target
hardware.

• Integration with existing application code.
• Compliance with a standard, such as AUTOSAR.
• Modification of code behavior, such as enabling or disabling nonfinite or inline support.
• Application- or project-specific code requirements, such as:

• Elimination of math.h.
• Elimination of system header files.
• Elimination of calls to memcpy or memset.
• Use of BLAS.
• Use of a specific BLAS.

To apply this technique, configure the code generator to apply a code replacement library (CRL)
during code generation. By default, the code generator does not apply a code replacement library.
You can choose from libraries that MathWorks provides and that you create and register by using the
Embedded Coder product. The list of available libraries depends on:

• Installed support packages.
• System target file, language, standard math library, and device vendor configuration.
• Whether you have created and registered libraries, using the Embedded Coder product.

Libraries that include GNU99 extensions are intended for use with the GCC compiler. If you use one
of those libraries with another compiler, generated code might not compile.

Code Replacement Libraries
A code replacement library consists of one or more code replacement tables that specify application-
specific implementations of functions and operators. For example, a library for a specific embedded
processor specifies function and operator replacements that optimize generated code for that
processor.

A code replacement table contains one or more code replacement entries, with each entry
representing a potential replacement for a function or operator. Each entry maps a conceptual
representation of a function or operator to an implementation representation and priority.
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Table Entry
Component

Description

Conceptual
representation

Identifies the table entry and contains match criteria for the code generator.
Consists of:

• Function name or a key. The function name identifies most functions. For
operators and some functions, a series of characters, called a key
identifies a function or operator. For example, function name 'cos' and
operator key 'RTW_OP_ADD'.

• Conceptual arguments that observe code generator naming ('y1', 'u1',
'u2', ...), with corresponding I/O types (output or input) and data types.

• Other attributes, such as an algorithm, fixed-point saturation, and
rounding modes, which identify matching criteria for the function or
operator.

Implementation
representation

Specifies replacement code. Consists of:

• Function name. For example, 'cos_dbl' or 'u8_add_u8_u8'.
• Implementation arguments, with corresponding I/O types (output or

input) and data types.
• Parameters that provide additional implementation details, such as

header and source file names and paths of build resources.
Priority Defines the entry priority relative to other entries in the table. The value can

range from 0 to 100, with 0 being the highest priority. If multiple entries
have the same priority, the code generator uses the first match with that
priority.

When the code generator looks for a match in a code replacement library, it creates and populates a
call site object with the function or operator conceptual representation. If a match exists, the code
generator uses the matched code replacement entry populated with the implementation
representation and uses it to generate code.

The code generator searches the tables in a code replacement library for a match in the order that
the tables appear in the library. If the code generator finds multiple matches within a table, the
priority determines the match. The code generator uses a higher-priority entry over a similar entry
with a lower priority.
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Code Replacement Terminology
Term Definition
Cache hit A code replacement entry for a function or operator,

defined in the specified code replacement library, for
which the code generator finds a match.

Cache miss A conceptual representation of a function or operator for
which the code generator does not find a match.

Call site object Conceptual representation of a function or operator that
the code generator uses when it encounters a call site for
a function or operator. The code generator uses the object
to query the code replacement library for a conceptual
representation match. If a match exists, the code
generator returns a code replacement object, fully
populated with the conceptual representation,
implementation representation, and priority, and uses that
object to generate replacement code.

Code replacement library One or more code replacement tables that specify
application-specific implementations of functions and
operators. When configured to use a code replacement
library, the code generator uses criteria defined in the
library to search for matches. If a match is found, the code
generator replaces code that it generates by default with
application-specific code defined in the library.

Code replacement table One or more code replacement table entries. Provides a
way to group related or shared entries for use in different
libraries.

Code replacement entry Represents a potential replacement for a function or
operator. Maps a conceptual representation of a function
or operator to an implementation representation and
priority.

Conceptual argument Represents an input or output argument for a function or
operator being replaced. Conceptual arguments observe
naming conventions ('y1', 'u1', 'u2', ...) and data types
familiar to the code generator.

Conceptual representation Represents match criteria that the code generator uses to
qualify functions and operators for replacement. Consists
of:

• Function or operator name or key
• Conceptual arguments with type, dimension, and

complexity specification for inputs and output
• Attributes, such as an algorithm and fixed-point

saturation and rounding modes
Implementation argument Represents an input or output argument for a C or C++

replacement function. Implementation arguments observe
C/C++ name and data type specifications.
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Term Definition
Implementation representation Specifies C or C++ replacement function prototype.

Consists of:

• Function name (for example, 'cos_dbl' or
'u8_add_u8_u8')

• Implementation arguments specifying type, type
qualifiers, and complexity for the function inputs and
output

• Parameters that provide build information, such as
header and source file names and paths of build
resources and compile and link flags

Key Identifies a function or operator that is being replaced. A
function name or key appears in the conceptual
representation of a code replacement entry. The key
RTW_OP_ADD identifies the addition operator.

Priority Defines the match priority for a code replacement entry
relative to other entries, which have the same name and
conceptual argument list, within a code replacement
library. The priority can range from 0 to 100, with 0 being
the highest priority. The default is 100. If a library provides
two implementations for a function or operator, the
implementation with the higher priority shadows the one
with the lower priority.

Code Replacement Limitations
Code replacement verification — It is possible that code replacement behaves differently than you
expect. For example, data types that you observe in code generator input might not match what the
code generator uses as intermediate data types during an operation. Verify code replacements by
examining generated code.

Code replacement for matrices — Code replacement libraries do not support Dynamic and Symbolic
sized matrices.

See Also

Related Examples
• “Choose a Code Replacement Library”
• “Replace Code Generated from Simulink Models”
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Choose a Code Replacement Library
In this section...
“About Choosing a Code Replacement Library” on page 54-6
“Explore Available Code Replacement Libraries” on page 54-6
“Explore Code Replacement Library Contents” on page 54-6

About Choosing a Code Replacement Library
By default, the code generator does not use a code replacement library.

If you are considering using a code replacement library:

1 Explore available libraries. Identify one that best meets your application needs.

• Consider the lists of application code replacement requirements and libraries that MathWorks
provides in “What Is Code Replacement?” on page 55-2.

• See “Explore Available Code Replacement Libraries” on page 54-6.
2 Explore the contents of the library. See “Explore Code Replacement Library Contents” on page

54-6.

If you do not find a suitable library and you have an Embedded Coder license, you can create a
custom code replacement library.

Explore Available Code Replacement Libraries
Select the “Code replacement library” to use for code generation from the Configuration
Parameters > Code Generation > Interface pane . To view a description of a library, select and
hover your cursor over the library name. A tooltip describes the library and lists the tables that it
contains. The tooltip lists the tables in the order that the code generator searches for a function or
operator match.

Explore Code Replacement Library Contents
Use the Code Replacement Viewer to explore the content of a code replacement library.

1 At the command prompt, type crviewer.
>> crviewer

The viewer opens. To view the content of a specific library, specify the name of the library as an
argument in single quotes. For example:
>> crviewer('GNU C99 extensions')

2 In the left pane, select the name of a library. The viewer displays information about the library in
the right pane.

3 In the left pane, expand the library, explore the list of tables it contains, and select a table from
the list. In the middle pane, the viewer displays the function and operator entries that are in that
table, along with abbreviated information for each entry.
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4 In the middle pane, select a function or operator. The viewer displays information from the table
entry in the right pane.

If you select an operator entry that specifies net slope fixed-point parameters (instantiated from
entry class RTW.TflCOperationEntryGenerator or
RTW.TflCOperationEntryGenerator_NetSlope), the viewer displays an additional tab that
shows fixed-point settings.

See Code Replacement Viewer for details on what the viewer displays.

See Also

Related Examples
• “What Is Code Replacement?”
• “Replace Code Generated from Simulink Models”
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Replace Code Generated from Simulink Models
This example shows how to replace generated code, using a code replacement library. Code
replacement is a technique you can use to change the code that the code generator produces for
functions and operators to meet application code requirements. For example, you can replace
generated code to meet requirements such as:

• Optimization for a specific run-time environment, including, but not limited to, specific target
hardware.

• Integration with existing application code.
• Compliance with a standard, such as AUTOSAR.
• Modification of code behavior, such as enabling or disabling nonfinite or inline support.
• Application- or project-specific code requirements, such as elimination of math.h, system header
files, or calls to memcpy or memset, or use of BLAS.

Prepare for Code Replacement

1. Make sure that MATLAB®, Simulink®, Simulink Coder™, and a C compiler are installed on your
system. Some code replacement libraries available in your development environment can require
Embedded Coder®.

To install MathWorks® products, see the MATLAB installation documentation. If you have installed
MATLAB and want to see which other MathWorks products are installed, in the Command Window,
enter ver.

2. Identify an existing Simulink model or create a model for which you want the code generator to
replace code.

Choose a Code Replacement Library

By default, the code generator does not apply a code replacement library. You can choose from
libraries that MathWorks® provides and that you create and register by using the Embedded Coder®
product. The list of available libraries depends on:

• Installed support packages.
• System target file, language, standard math library, and device vendor configuration.
• Whether you have created and registered libraries, using the Embedded Coder® product.

Libraries that include GNU99 extensions are intended for use with the GCC compiler. If you use one
of those libraries with another compiler, generated code might not compile.

Depending on the product licenses that you have, other libraries might be available. If you have an
Embedded Coder license, you can view and choose from other libraries and you can create custom
code replacement libraries.

Configure Code Generator to Use Code Replacement Library

1. Configure the code generator to apply a code replacement library during code generation for the
model. Do one of the following:

• In the Configuration Parameters dialog box, on the Code Generation > Interface pane, select a
library for the “Code replacement library” parameter.
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• Set the CodeReplacementLibrary parameter at the command line or programmatically.

2. Configure the code generator to produce code only (not build an executable program) so you can
verify your code replacements before building an executable program. Do one of the following:

• In the Configuration Parameters dialog box, on the Code Generation pane, select “Generate code
only”.

• Set the GenCodeOnly parameter at the command line or programmatically.

Include Code Replacement Information in Code Generation Report

If you have an Embedded Coder license, you can configure the code generator to include a code
replacement section in the code generation report. The additional information can help you verify
code replacements.

1. Configure the code generator to generate a report. In the Configuration Parameters dialog box, on
the Code Generation > Report pane, select “Create code generation report”. Consider having the
report open automatically. Select Open report automatically.

2. Include the code replacement section in the report. Select “Summarize which blocks triggered
code replacements”.

Generate Replacement Code

Generate C/C++ code from the model and, if you configured the code generator accordingly, a code
generation report. For example, in the model window, press Ctrl+B.

The code generator produces the code and displays the report.

Verify Code Replacements

Verify code replacements by examining the generated code. It is possible that code replacement
behaves differently than you expect. For example, data types that you observe in the code generator
input might not match what the code generator uses as intermediate data types during an operation.

More About

• “What Is Code Replacement?”
• “Choose a Code Replacement Library”
• “Code Generation Configuration”
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Code Replacement for Simulink Models
in Embedded Coder

• “What Is Code Replacement?” on page 55-2
• “Choose a Code Replacement Library” on page 55-6
• “Replace Code Generated from Simulink Models” on page 55-8
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What Is Code Replacement?
Code replacement is a technique to change the code that the code generator produces for functions
and operators to meet application code requirements. For example, you can replace generated code
to meet requirements such as:

• Optimization for a specific run-time environment, including, but not limited to, specific target
hardware.

• Integration with existing application code.
• Compliance with a standard, such as AUTOSAR.
• Modification of code behavior, such as enabling or disabling nonfinite or inline support.
• Application- or project-specific code requirements, such as:

• Elimination of math.h.
• Elimination of system header files.
• Elimination of calls to memcpy or memset.
• Use of BLAS.
• Use of a specific BLAS.

To apply this technique, configure the code generator to apply a code replacement library (CRL)
during code generation. By default, the code generator does not apply a code replacement library.
You can choose from libraries that MathWorks provides and that you create and register by using the
Embedded Coder product. The list of available libraries depends on:

• Installed support packages.
• System target file, language, standard math library, and device vendor configuration.
• Whether you have created and registered libraries, using the Embedded Coder product.

Libraries that include GNU99 extensions are intended for use with the GCC compiler. If you use one
of those libraries with another compiler, generated code might not compile.

Code Replacement Libraries
A code replacement library consists of one or more code replacement tables that specify application-
specific implementations of functions and operators. For example, a library for a specific embedded
processor specifies function and operator replacements that optimize generated code for that
processor.

A code replacement table contains one or more code replacement entries, with each entry
representing a potential replacement for a function or operator. Each entry maps a conceptual
representation of a function or operator to an implementation representation and priority.
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Table Entry
Component

Description

Conceptual
representation

Identifies the table entry and contains match criteria for the code generator.
Consists of:

• Function name or a key. The function name identifies most functions. For
operators and some functions, a series of characters, called a key
identifies a function or operator. For example, function name 'cos' and
operator key 'RTW_OP_ADD'.

• Conceptual arguments that observe code generator naming ('y1', 'u1',
'u2', ...), with corresponding I/O types (output or input) and data types.

• Other attributes, such as an algorithm, fixed-point saturation, and
rounding modes, which identify matching criteria for the function or
operator.

Implementation
representation

Specifies replacement code. Consists of:

• Function name. For example, 'cos_dbl' or 'u8_add_u8_u8'.
• Implementation arguments, with corresponding I/O types (output or

input) and data types.
• Parameters that provide additional implementation details, such as

header and source file names and paths of build resources.
Priority Defines the entry priority relative to other entries in the table. The value can

range from 0 to 100, with 0 being the highest priority. If multiple entries
have the same priority, the code generator uses the first match with that
priority.

When the code generator looks for a match in a code replacement library, it creates and populates a
call site object with the function or operator conceptual representation. If a match exists, the code
generator uses the matched code replacement entry populated with the implementation
representation and uses it to generate code.

The code generator searches the tables in a code replacement library for a match in the order that
the tables appear in the library. If the code generator finds multiple matches within a table, the
priority determines the match. The code generator uses a higher-priority entry over a similar entry
with a lower priority.
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Code Replacement Terminology
Term Definition
Cache hit A code replacement entry for a function or operator,

defined in the specified code replacement library, for
which the code generator finds a match.

Cache miss A conceptual representation of a function or operator for
which the code generator does not find a match.

Call site object Conceptual representation of a function or operator that
the code generator uses when it encounters a call site for
a function or operator. The code generator uses the object
to query the code replacement library for a conceptual
representation match. If a match exists, the code
generator returns a code replacement object, fully
populated with the conceptual representation,
implementation representation, and priority, and uses that
object to generate replacement code.

Code replacement library One or more code replacement tables that specify
application-specific implementations of functions and
operators. When configured to use a code replacement
library, the code generator uses criteria defined in the
library to search for matches. If a match is found, the code
generator replaces code that it generates by default with
application-specific code defined in the library.

Code replacement table One or more code replacement table entries. Provides a
way to group related or shared entries for use in different
libraries.

Code replacement entry Represents a potential replacement for a function or
operator. Maps a conceptual representation of a function
or operator to an implementation representation and
priority.

Conceptual argument Represents an input or output argument for a function or
operator being replaced. Conceptual arguments observe
naming conventions ('y1', 'u1', 'u2', ...) and data types
familiar to the code generator.

Conceptual representation Represents match criteria that the code generator uses to
qualify functions and operators for replacement. Consists
of:

• Function or operator name or key
• Conceptual arguments with type, dimension, and

complexity specification for inputs and output
• Attributes, such as an algorithm and fixed-point

saturation and rounding modes
Implementation argument Represents an input or output argument for a C or C++

replacement function. Implementation arguments observe
C/C++ name and data type specifications.
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Term Definition
Implementation representation Specifies C or C++ replacement function prototype.

Consists of:

• Function name (for example, 'cos_dbl' or
'u8_add_u8_u8')

• Implementation arguments specifying type, type
qualifiers, and complexity for the function inputs and
output

• Parameters that provide build information, such as
header and source file names and paths of build
resources and compile and link flags

Key Identifies a function or operator that is being replaced. A
function name or key appears in the conceptual
representation of a code replacement entry. The key
RTW_OP_ADD identifies the addition operator.

Priority Defines the match priority for a code replacement entry
relative to other entries, which have the same name and
conceptual argument list, within a code replacement
library. The priority can range from 0 to 100, with 0 being
the highest priority. The default is 100. If a library provides
two implementations for a function or operator, the
implementation with the higher priority shadows the one
with the lower priority.

Code Replacement Limitations
Code replacement verification — It is possible that code replacement behaves differently than you
expect. For example, data types that you observe in code generator input might not match what the
code generator uses as intermediate data types during an operation. Verify code replacements by
examining generated code.

Code replacement for matrices — Code replacement libraries do not support Dynamic and Symbolic
sized matrices.

See Also

Related Examples
• “Choose a Code Replacement Library” on page 55-6
• “Replace Code Generated from Simulink Models” on page 55-8
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Choose a Code Replacement Library
In this section...
“About Choosing a Code Replacement Library” on page 55-6
“Explore Available Code Replacement Libraries” on page 55-6
“Explore Code Replacement Library Contents” on page 55-6

About Choosing a Code Replacement Library
By default, the code generator does not use a code replacement library.

If you are considering using a code replacement library:

1 Explore available libraries. Identify one that best meets your application needs.

• Consider the lists of application code replacement requirements and libraries that MathWorks
provides in “What Is Code Replacement?” on page 55-2.

• See “Explore Available Code Replacement Libraries” on page 55-6.
2 Explore the contents of the library. See “Explore Code Replacement Library Contents” on page

55-6.

If you do not find a suitable library and you have an Embedded Coder license, you can create a
custom code replacement library.

Explore Available Code Replacement Libraries
Select the “Code replacement library” to use for code generation from the Configuration
Parameters > Code Generation > Interface pane . To view a description of a library, select and
hover your cursor over the library name. A tooltip describes the library and lists the tables that it
contains. The tooltip lists the tables in the order that the code generator searches for a function or
operator match.

Explore Code Replacement Library Contents
Use the Code Replacement Viewer to explore the content of a code replacement library.

1 At the command prompt, type crviewer.
>> crviewer

The viewer opens. To view the content of a specific library, specify the name of the library as an
argument in single quotes. For example:
>> crviewer('GNU C99 extensions')

2 In the left pane, select the name of a library. The viewer displays information about the library in
the right pane.

3 In the left pane, expand the library, explore the list of tables it contains, and select a table from
the list. In the middle pane, the viewer displays the function and operator entries that are in that
table, along with abbreviated information for each entry.
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4 In the middle pane, select a function or operator. The viewer displays information from the table
entry in the right pane.

If you select an operator entry that specifies net slope fixed-point parameters (instantiated from
entry class RTW.TflCOperationEntryGenerator or
RTW.TflCOperationEntryGenerator_NetSlope), the viewer displays an additional tab that
shows fixed-point settings.

See Code Replacement Viewer for details on what the viewer displays.

See Also

Related Examples
• “What Is Code Replacement?” on page 55-2
• “Replace Code Generated from Simulink Models” on page 55-8
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Replace Code Generated from Simulink Models
This example shows how to replace generated code, using a code replacement library. Code
replacement is a technique you can use to change the code that the code generator produces for
functions and operators to meet application code requirements. For example, you can replace
generated code to meet requirements such as:

• Optimization for a specific run-time environment, including, but not limited to, specific target
hardware.

• Integration with existing application code.
• Compliance with a standard, such as AUTOSAR.
• Modification of code behavior, such as enabling or disabling nonfinite or inline support.
• Application- or project-specific code requirements, such as elimination of math.h, system header
files, or calls to memcpy or memset, or use of BLAS.

Prepare for Code Replacement

1. Make sure that MATLAB®, Simulink®, Simulink Coder™, and a C compiler are installed on your
system. Some code replacement libraries available in your development environment can require
Embedded Coder®.

To install MathWorks® products, see the MATLAB installation documentation. If you have installed
MATLAB and want to see which other MathWorks products are installed, in the Command Window,
enter ver.

2. Identify an existing Simulink model or create a model for which you want the code generator to
replace code.

Choose a Code Replacement Library

By default, the code generator does not apply a code replacement library. You can choose from
libraries that MathWorks® provides and that you create and register by using the Embedded Coder®
product. The list of available libraries depends on:

• Installed support packages.
• System target file, language, standard math library, and device vendor configuration.
• Whether you have created and registered libraries, using the Embedded Coder® product.

Libraries that include GNU99 extensions are intended for use with the GCC compiler. If you use one
of those libraries with another compiler, generated code might not compile.

Depending on the product licenses that you have, other libraries might be available. If you have an
Embedded Coder license, you can view and choose from other libraries and you can create custom
code replacement libraries.

Configure Code Generator to Use Code Replacement Library

1. Configure the code generator to apply a code replacement library during code generation for the
model. Do one of the following:

• In the Configuration Parameters dialog box, on the Code Generation > Interface pane, select a
library for the “Code replacement library” parameter.

55 Code Replacement for Simulink Models in Embedded Coder

55-8



• Set the CodeReplacementLibrary parameter at the command line or programmatically.

2. Configure the code generator to produce code only (not build an executable program) so you can
verify your code replacements before building an executable program. Do one of the following:

• In the Configuration Parameters dialog box, on the Code Generation pane, select “Generate code
only”.

• Set the GenCodeOnly parameter at the command line or programmatically.

Include Code Replacement Information in Code Generation Report

If you have an Embedded Coder license, you can configure the code generator to include a code
replacement section in the code generation report. The additional information can help you verify
code replacements.

1. Configure the code generator to generate a report. In the Configuration Parameters dialog box, on
the Code Generation > Report pane, select “Create code generation report”. Consider having the
report open automatically. Select Open report automatically.

2. Include the code replacement section in the report. Select “Summarize which blocks triggered
code replacements”.

Generate Replacement Code

Generate C/C++ code from the model and, if you configured the code generator accordingly, a code
generation report. For example, in the model window, press Ctrl+B.

The code generator produces the code and displays the report.

Verify Code Replacements

Verify code replacements by examining the generated code. It is possible that code replacement
behaves differently than you expect. For example, data types that you observe in the code generator
input might not match what the code generator uses as intermediate data types during an operation.

More About

• “What Is Code Replacement?”
• “Choose a Code Replacement Library”
• “Code Generation Configuration”
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External Code Integration in Simulink
Coder

The code generator includes multiple approaches for integrating legacy or custom code with
generated code. Legacy code is existing handwritten code or code for environments that you
integrate with code produced by the code generator. Custom code is legacy code or other user-
specified lines of code that you include in the code generator build process. Collectively, legacy and
custom code are called external code.

You integrate external code by importing existing external code into code produced by the code
generator, exporting generated code into an existing external code base, or you can do both. For
example, you can import code by calling an external function, by using the Legacy Code Tool, or place
external code at specific locations in generated code by including Custom Code blocks in a model.
When you import external code, the resulting generated code interfaces with generated scheduling
code.

You can export generated code as a plug-in function for use in an external development environment.
When you export generated code, you intend to interface that code manually with a scheduling
mechanism in your application run-time environment.

For guidance on choosing an approach based on your application, see “Choose an External Code
Integration Workflow” .

• “What Is External Code Integration?” on page 56-2
• “Choose an External Code Integration Workflow” on page 56-3
• “Configure Target Hardware Characteristics” on page 56-9
• “Check Code Generation Assumptions” on page 56-12
• “Call Reusable External Algorithm Code for Simulation and Code Generation” on page 56-15
• “Place External C/C++ Code in Generated Code” on page 56-30
• “Call External Device Drivers” on page 56-38
• “Apply Function and Operator Code Replacements” on page 56-39
• “Build Integrated Code Within the Simulink Environment” on page 56-40
• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Generate Shared Library for Export to External Code Base” on page 56-62
• “Interface to a Development Computer Simulator By Using a Shared Library” on page 56-67
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code”

on page 56-69
• “Exchange Data Between External Calling Code and Generated Code” on page 56-77
• “Generate Code That Matches Appearance of External Code” on page 56-80
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What Is External Code Integration?
Software projects typically involve combining code from multiple sources. A typical system structure
for a code generation application consists of a framework that combines code from multiple sources,
including external code and code generated from Simulink models.

This figure shows an application that requires integration of existing driver code for hardware
devices. The core software algorithms and logic can be a combination of code modules for external
reusable algorithms integrated into the Simulink environment and code generated as part of an
overall model design.

Several workflows and tools are available for you to integrate external and generated code. Each
workflow identifies tooling for generating code that aligns interfaces, code appearance, and other
factors, such as optimization between external and generated code.

See Also

More About
• “Choose an External Code Integration Workflow” on page 56-3
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Choose an External Code Integration Workflow
In this section...
“Choose a Software Execution Framework for Scheduling Code Execution” on page 56-3
“Evaluate Characteristics of External Code” on page 56-5
“Identify Integration Requirements” on page 56-6
“Choose a Workflow” on page 56-7

Completing these tasks helps you choose external code integration workflows and tooling that align
with your project.

Task Action More Information
1 Partition your application, map algorithms to

components, and identify integration points.
“Design Models for Generated Embedded
Code Deployment” on page 1-2

2 Determine whether you can rely on scheduling
code that the code generator produces, or
whether you must integrate generated code
with scheduling mechanisms that are specific
to your run-time environment.

“Choose a Software Execution Framework
for Scheduling Code Execution” on page 56-
3

3 Evaluate the characteristics of the external
code that you are importing or to which you
are exporting generated code.

“Evaluate Characteristics of External Code”
on page 56-5

4 Identify integration requirements, which
assists with choosing optimal tooling for your
integration.

“Identify Integration Requirements” on page
56-6

5 Based on the results of tasks 1–4, choose a
workflow.

“Choose a Workflow” on page 56-7

Choose a Software Execution Framework for Scheduling Code
Execution
The code generator supports two types of software execution frameworks—single top model and
multiple top-level, as described in “Design Models for Generated Embedded Code Deployment” on
page 1-2. The first question to answer concerns which of the two frameworks meets the scheduling
and other needs of your project. For example, you can import external code into a single, rate-based
top model. You can export code from a single top model or multiple top-level models for integration
with custom (external) scheduling mechanisms.

• Single top model

Generate one set of application code files from external code and code that the Simulink C/C++
code generator produces. The generated code includes a scheduler. In this case, you import code
into the Simulink code generation environment.
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• Single top model or multiple top-level models

Integrate C or C++ code that the code generator produces from model components with external
application code and an external scheduler. You export generated code from the Simulink code
generation environment.

56 External Code Integration in Simulink Coder

56-4



Importing calls to external device driver code into a model and generating code for that model for
export involves importing and exporting code.

Based on goals and requirements, external code integration is characterized in several ways,
requiring different workflows and integration tooling:

• Import existing external code into generated code.

• Call reusable external algorithm code for simulation and code generation.
• Place external C/C++ code in generated code.
• Call external device drivers.
• Apply function and operator code replacements.
• Interface with external timer interrupt or scheduler.
• Generate replacement code for specific run-time environment.

• Export generated code for inclusion in external code base. Requires Embedded Coder .

• Generate component source code for export.
• Generate shared library for export.

Next, see “Evaluate Characteristics of External Code” on page 56-5.

Evaluate Characteristics of External Code
Before choosing an external integration workflow, evaluate these characteristics of the external code.
To interface with external code, generated C or C++ code handles one or more of the external code
characteristics. An understanding of these characteristics and your requirements for modeling,
simulation, and code generation helps you choose the optimal workflow for your integration scenario.
(See “Identify Integration Requirements” on page 56-6.)

Characteristic What to Consider
Hardware
dependency

Is the external code hardware-dependent? Utility functions, lookup tables,
and filters are examples of hardware-independent code.

Device drivers interact directly with hardware. They depend on
characteristics of the hardware. For example, a device driver for an analog-
to-digital converter initializes, reads data from, and writes data to hardware
registers. Hardware differences and dependencies concern data type size,
endianess, shift operations, compiler directives, and optimized function and
operator support. Other code interfaces with device drivers by using an API
and data mapped to specific memory addresses. Typically, simulation on a
development computer is not possible. Reading from and writing to a
register during simulation on a development computer produces unexpected
and unwanted results.

Reusable Is the external code a reusable software module? Examples include utility
functions, lookup tables, filters, specialized integrators, and proportional-
integral-derivative (PID) control modules.
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Characteristic What to Consider
Dependency on data
persistence between
function calls

Does the external code require persistent data? For example, a call to a first
order filter function uses the output of the previous call to the function to
calculate a new output value. You have the option of defining the data as
global or using shared memory outside the context of the function.

Data typing and
interface

How complex is the data that the external code uses? What does the data
interface look like? It consists of arguments, a return value, global variables,
and access functions. What data types does the code use? Are the types
limited to basic ANSI C integers, floating-point types, arrays of integers or
floating-point types, and pointers to these types? Does the interface include
structures or pointers to structures?

Fixed-point code Is the external code designed to run on integer-only processors? If yes, the
code exchanges and uses data represented as integers only. Data can be
associated with fixed-point scaling or offsets.

External resource
dependencies

Does the external code use data, functions, or macros defined outside the
scope of the code? For example, the function can use a standard ANSI
function, a shared library, or predefined constants. In these cases, you must
inform the compiler and linker of the paths and file names of the external
resources.

External solver
required

Are you using the external function for advanced development or rapid
prototyping to describe a system with a continuous transfer function or a set
of differential equations? If yes, the external code relies on an external
solver.

Next, see “Identify Integration Requirements” on page 56-6.

Identify Integration Requirements
Before choosing an external integration workflow, review these integration requirements. An
understanding of these requirements and the characteristics of your external code helps you choose
the optimal workflow for your integration scenario. (See “Evaluate Characteristics of External Code”
on page 56-5.)

Requirement What to Consider
Effort What level of effort is planned for the integration project—low, medium, or

high?
Learning effort What is the programming experience of assigned project resources? How

much experience do assigned resources have with Simulink and MathWorks
C/C++ code generation products?

Simulation and code
generation behaviors

Do you want to take advantage of Model-Based Design? To take full
advantage of Model-Based Design, convert code to modeling elements, which
you can then use in the Simulink and Stateflow simulation environment.
Then, simulate and generate code for the integrated component. Use
software-in-the-loop (SIL) or processor-in-the-loop (PIL) testing to verify
whether algorithm behavior is the same in both environments.
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Requirement What to Consider
Data interface and
typing

• Does your model or generated code need to exchange data with the
external function? If so, map inputs, outputs, and parameters to the
external function interface. Typical function interfaces involve function
arguments and return values, global variables, and access functions, such
as getRPM.

• Do you want to represent arrays, structures, or enumerated types? In the
Simulink environment, you can represent these types as vectors, buses,
and IntEnum, respectively.

• Is fixed-point support required? If you use the Simulink fixed-point
interface, you can scale and specify offsets.

• Does the external code use company-specific data types? If yes and you
have Embedded Coder software, create alias types to represent those
external types. The code generator uses the alias types in the code that it
produces. For example, once defined, you can specify an alias type in a
function prototype, for a temporary variable, or for block output.

• Does the code exchange data with shared memory? If yes, define and use
memory sections.

Direct function call Do you want to call C external code directly from a model? You can choose
from mechanisms, such as the Legacy Code Tool, Stateflow external code
interface and chart action language, and the MATLAB Function block.

Insertion of external
code into generated
code

Do you want to control the placement of external code within generated
code? Do you want to insert code into generated entry-point functions? You
can place code within generated code by using model configuration
parameters or custom code blocks.

Code generation
optimization support

Do you want to optimize the code that the code generator produces? If so,
you can configure the model for the code generator to optimize the code it
produces based on application objectives, such as execution, ROM, and RAM
efficiency. You also have the option of using code replacement libraries.

Files required Do you want to minimize the number of files that you maintain? Some
external code integration tools require that you maintain separate files for
defining simulation and code generation.

Next, see “Choose a Workflow” on page 56-7.

Choose a Workflow
To choose a workflow for each integration point, use the following flow diagram . The gray boxes
identify common workflows and provide links to more information. Click the gray box that best
addresses the requirements of an integration point.
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See Also

More About
• “Call Reusable External Algorithm Code for Simulation and Code Generation” on page 56-15
• “Place External C/C++ Code in Generated Code” on page 56-30
• “Call External Device Drivers” on page 56-38
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Deploy Generated Component Software to Application Target Platforms” on page 66-26
• “Code Replacement”
• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Generate Shared Library for Export to External Code Base” on page 56-62

56 External Code Integration in Simulink Coder

56-8



Configure Target Hardware Characteristics
Simulink® allows you to configure the hardware implementation characteristics of your target
system. Failure to do so can result in code that is incorrect or inefficient.

Open Example Model

Open the example model rtwdemo_targetsettings.

open_system('rtwdemo_targetsettings');
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Open the Hardware Implementation pane of the Configuration Parameters dialog box by double-
clicking the yellow button in the model.
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Hardware Board Configuration

By default, the model is configured for the code generator to determine the hardware board
configuration based on the specified system target file. The default system target file setting is
grt.tlc.

If you have installed support for a hardware board, that board should appear in the Hardware board
menu. If you select it, the dialog box displays parameters that are relevant to your hardware board.

My Hardware Board is Not Listed

If you are using a hardware board that is not listed, add it to the menu by installing the
corresponding target support package. Start the Support Package Installer by setting Hardware
board to Get hardware Support Packages, or by entering supportPackageInstaller in the
MATLAB® Command Window.

After installing support for a hardware board, reopen the Configuration Parameters dialog box and
select the hardware board.

Cross-Development Systems that Include Source Level Debuggers

If you use a cross-development system that includes a source level debugger:

1. Configure the model for your hardware board.

2. Generate code and build an executable using your target development system. For details about
retrieving file and path information, see the documentation on the Simulink Coder® Build
Information API.

3. Download the executable to the target hardware and set breakpoints at the model output code for
each outport of the model.

4. Run a debugging session and observe the behavior of the code as it executes on the target
hardware. As you step through the code, it computes the values for target hardware device
characteristics.

If your target development system does not support source level debugging, generate code and add
printf statements or other code that gets the results.

5. On the Hardware Implementation pane of the Configuration Parameters dialog box, set Device
vendor to Custom processor, click the Device details arrow, and adjust the microprocessor
device settings manually.
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Check Code Generation Assumptions
The code generator implements assumptions that depend, for example, on the hardware
implementation settings for your model. It is important to check that the assumptions are valid for
your target hardware. Use the buildStandaloneCoderAssumptions function to create an
application that performs assumption checks on your target hardware.

When you configure your model, try to specify hardware implementation and build configuration
settings that match your target hardware. Then, to check code generator assumptions for your target
hardware, use this workflow:

1 With GenerateReport set to 'on', build (Ctrl+B) your model.
2 To view the list of code generator assumptions that you can check, open the code generation

report and click the Coder Assumptions link.

For more information, see “Coder Assumptions List” on page 56-13.
3 Run buildStandaloneCoderAssumptions, which uses the generated code in the build folder

to create an application that runs code generation assumption checks.
4 Download the application onto the target hardware or target environment, and then run the

application.
5 While the application runs, use a debug tool to view check results that are in a data structure.

Check Code Generator Assumptions for Development Computer
If the target hardware is, for example, your Windows development computer, you can use Microsoft
Visual Studio® to run and debug the application:

1 To open a model, in the Command Window, enter rtwdemo_sil_topmodel.
2 In the Model Configuration Parameters dialog box, in the Hardware Implementation pane,

specify settings to match the target hardware. For example, for a 64-bit Windows computer
specify these parameter settings:

• Device vendor –– Intel
• Device type –– x86-64 (Windows 64)

3 Clear model configuration parameter Enable portable word sizes.
4 Build the model (Ctrl+B).
5 To view the list of code generator assumptions, open the code generation report and click the

Coder Assumptions link.
6 From the Command Window, in the working folder, run:

buildStandaloneCoderAssumptions('rtwdemo_sil_topmodel_ert_rtw')

In the build folder, the function creates the coderassumptions\standalone subfolder, which
contains the target application, rtwdemo_sil_topmodel_ca.

7 Open Microsoft Visual Studio and select File > Open > Project/Solution
8 Using the Open Project dialog box, navigate to the coderassumptions\standalone subfolder

and select rtwdemo_sil_topmodel_ca. Then, click Open.
9 Select File > Open > File. Using the Open File dialog box, select coderassumptions

\standalone\rtwdemo_sil_topmodel_ca.c
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10 At the return statement, insert a break point.
11 Select Debug > Start Debugging.
12 To verify code generator assumptions, use a Watch window to inspect the Results data

structure:

a In the rtwdemo_sil_topmodel_ca.c code, right-click Results.
b From the context menu, select Add Watch.

The variables in the data structure contain:

• Check outcomes (TestResults)
• Target hardware truths (ActualValues)
• Code generator assumptions (ExpectedValues)

For example, if the code generator assumption for bitsPerChar is accurate, you see the CA_PASS
value in the status variable.

Coder Assumptions List
The contents section of the code generation report has a link to the Coder Assumptions page. The
page provides a list of:

• Code generation assumptions that you can check
• Expected results for the assumption checks

This table describes the labels that you see in the list.

Category Label Assumption You Can Check
C/C++ Language
Configuration for Target
Hardware or Development
Computer

BitPerChar Number of bits per char
(ProdBitPerChar)

BitPerShort Number of bits per short
(ProdBitPerShort)

BitPerInt Number of bits per int
(ProdBitPerInt)

BitPerLong Number of bits per long
(ProdBitPerLong)

BitPerFloat Size of float (Only if
PurelyIntegerCode is 'off')
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Category Label Assumption You Can Check
BitPerDouble Size of double (Only if

PurelyIntegerCode is ‘off’)
BitPerPointer Number of bits per pointer

(ProdBitPerPointer)
BitPerSizeT Number of bits per size_t

(ProdBitPerSizeT)
BitPerPtrDiffT Number of bits per ptrdiff_t

(ProdBitPerPtrDiffT)
Endianess Byte ordering (ProdEndianess)
Shift right for signed
integer is arithmetic
shift

Sign bit behavior
(ProdShiftRightIntArith)

Signed integer
division rounds to

Rounding behavior for integer division
(ProdIntDivRoundTo)

C/C++ Language Standard Initial value of a
global integer
variable and
dynamically allocated
memory is zero

Zero initialization of memory
(ZeroExternalMemoryAtStartup,
ZeroInternalMemoryAtStartup, and
GenerateAllocFcn)

Floating-Point Numbers Flush-to-zero computed
subnormal values (FTZ)

Flush-to-zero subnormal number
processing

Flush-to-zero incoming
subnormal values (DAZ)

Denormals-are-zero subnormal number
processing

See Also
buildStandaloneCoderAssumptions

More About
• “Verification of Code Generation Assumptions” on page 80-62

56 External Code Integration in Simulink Coder

56-14



Call Reusable External Algorithm Code for Simulation and Code
Generation

Code reuse offers business and technological advantages. From a business perspective, code reuse
saves time and resources. From a technological perspective, code reuse promotes consistency and
reduces memory requirements. Other considerations include:

• Modularizing an application
• Reusing an optimized algorithm
• Interfacing with a predefined dataset
• Developing application variants

Examples of reusable hardware-independent algorithmic code to consider importing into the Simulink
environment for simulation and code generation include:

• Utility functions
• Lookup tables
• Digital filters
• Specialized integrators
• Proportional-integral-derivative (PID) control modules

Workflow
To call reusable external algorithm code for simulation and code generation, iterate through the tasks
listed in this table.

Task Action More Information
1 Review your assessment of external code

characteristics and integration
requirements.

“Choose an External Code Integration Workflow”
on page 56-3

2 Based on the programming language of
the external code, choose an integration
approach to add the external code to a
Simulink model.

“Choose an Integration Approach” on page 56-16

3 Verify algorithm behavior and
performance by simulating the model.

“Simulation”

4 Define the representation of model data
for code generation.

“Exchange Data Between External C/C++ Code
and Simulink Model or Generated Code” on page
56-69

5 Configure the model for code generation. “Generate Code That Matches Appearance of
External Code” on page 56-80 and “Model
Configuration”

6 Generate code and a code generation
report.

“Code Generation”

7 Review the generated code interface and
static code metrics.

“Analyze the Generated Code Interface” on page
52-13 and “Static Code Metrics” on page 52-23
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Task Action More Information
8 Build an executable program from the

model.
“Build Integrated Code Within the Simulink
Environment” on page 56-40

9 Verify that executable program behaves
as expected.

“Numerical Equivalence Testing”

10 Verify that executable program performs
as expected.

“Code Execution Profiling”

Choose an Integration Approach
Several approaches are available for integrating reusable algorithmic code into the Simulink
environment for code generation. Some approaches integrate external code directly. Other
approaches convert the external code to Simulink or Stateflow modeling elements for simulation, and
later for code generation from the modeled design. The integration approach that you choose
depends on:

• Programming language of the external code — MATLAB, C, C++, or Fortran
• Your programming language experience and preference
• Performance requirements
• Whether the algorithm must model continuous time dynamics or you are integrating the algorithm

into an application that uses discrete and continuous time
• Whether you want to take advantage of Model-Based Design
• Level of control required over the code that the code generator produces

To choose an approach for a reusable algorithm, see the subsection that matches the programming
language of your external algorithm code.

• “Integration Approaches for External MATLAB Code” on page 56-16
• “Integration Approaches for External C or C++ Code” on page 56-19
• “Integration Approaches for External Fortran Code” on page 56-23

Integration Approaches for External MATLAB Code

Multiple approaches are available for integrating external MATLAB code into the Simulink
environment. The following diagram and table help you choose the best integration approach for your
application based on integration requirements.
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 Condition or
Requirement

Action More Information

1 The algorithm must model
continuous state dynamics.

Write a MATLAB S-function
and, for generating code, a
corresponding TLC file for the
algorithm. Add the S-function
to your model.

• “Create and Configure MATLAB S-
Functions”

• “S-Functions”
• “Target Language Compiler”

2 External code complies
with the MATLAB code for
code generation subset
and you want to call
MATLAB code from a
Simulink model.

Add a MATLAB Function block
to the model. Embed the
MATLAB code in that block.

• “Integrate C Code Using the MATLAB
Function Block”

• MATLAB Function
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 Condition or
Requirement

Action More Information

3 External code complies
with the MATLAB code for
code generation subset,
you want to call MATLAB
code from a Simulink
model, and your algorithm
includes iterative
computations that process
large streams of data.

Add a MATLAB System block to
the model. Embed the MATLAB
code in that block as a System
object™.

• “Integrate C Code Using the MATLAB
Function Block”

• MATLAB System

4 External code complies
with the MATLAB code for
code generation subset,
you want to call MATLAB
code from a Simulink
model, and your algorithm
includes design logic that
is based on state machines
and flow charts.

Add a Stateflow chart to the
model. Call the external code
from the chart, using MATLAB
as the action language.

• “Chart Programming Basics” (Stateflow)
• “Insert External Code into Stateflow

Charts” on page 56-23

5 You want to use the
parfor function for
parallel computing or
interface data types that
are available to MATLAB
Coder, Simulink Coder,
and Embedded Coder. To
use parfor, Parallel
Computing Toolbox must
be installed.

Use software to generate C
code. Then, call that generated
code as external C code.

• “Generate C Code by Using the MATLAB
Coder App”

• “Get Started with MATLAB Coder”

6 You have C or C++
programming experience
and the external MATLAB
code is compact and
primarily uses C or C++
constructs.

Manually convert the MATLAB
code to C or C++ code. Choose
an integration approach for C
or C++ code.

“Integration Approaches for External C or C
++ Code” on page 56-19

7 Sections of the external
MATLAB code map to
built-in blocks.

Develop the algorithm in the
context of a model, using the
applicable built-in blocks.

• “Interactive Model Editing” and “Project
Management”

• “Blocks and Products Supported for Code
Generation”

To embed external MATLAB code in a MATLAB Function block or generate C or C++ code from
MATLAB code with the MATLAB Coder software, the MATLAB code must use functions and classes
supported for C/C++ code generation.

• “Functions and Objects Supported for C/C++ Code Generation”
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Integration Approaches for External C or C++ Code

Under most circumstances, you can integrate external code written in C or C++ into the Simulink
environment by generating S-functions and TLC files with the Legacy Code Tool. This tool uses
specifications that you supply as MATLAB code to transform existing MATLAB functions into C MEX
S-functions that you can include in Simulink models and call from generated code. For details, see
“Implement Algorithms Using Legacy Code Tool” and “Import Calls to External Code into Generated
Code with Legacy Code Tool” on page 13-6.

In comparison to alternative approaches, Legacy Code Tool is the most optimal choice for generating
code optimized enough for embedded systems. Consider alternative approaches if one or more of the
following conditions exist:

• The external code uses global variables to exchange data.
• Programming experience is limited.
• The algorithm must model discrete and continuous state dynamics.
• You want to include the integrated external code in a Stateflow chart.
• The external code requires a fixed-point interface.
• You want maximum flexibility for controlling what code the code generator produces.
• You quickly want to embed a call to the external code in a call to the coder.ceval function that

is embedded in the MATLAB Function block, and performance is not an issue.

This diagram and table help you choose the best integration approach based on your integration
requirements.
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 Condition or
Requirement

Action More Information

1 You want to integrate
external C code with
generated C++ code or
conversely

Match the language choice
for the generated code by
modifying the language of
the external code.

“Modify Programming Language of External
Code to Match Generated Code” on page 56-
22
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 Condition or
Requirement

Action More Information

2 Your algorithm includes
design logic that is based
on state machines and flow
charts. Or, a function that
you want to integrate must
exchange data with a model
by using global variables.
The function defines the
global variables and uses
them to write output rather
than returning a value
(return) or writing output to
an argument.

Add a Stateflow chart to the
model. Call the external code
from the chart, using C as
the action language. In the
chart, write code that calls
the external function and
reads from and writes to the
global variables. To perform
calculations with output of
the external code, the model
must read from the global
variable during execution.

“Insert External Code into Stateflow Charts”
on page 56-23

3 You want to include
external C or C++ code in a
Stateflow chart for
simulation and code
generation.

Configure the model that
contains the chart to apply
the external C or C++ code.

• “Custom Code” (Stateflow)
• “Call C Library Functions in C Charts”
(Stateflow)

• “Insert External Code into Stateflow
Charts” on page 56-23

4 You quickly want to embed
a call to external C or C++
code in a model.
Performance is not an issue.

Call the C or C++ code with
the coder.ceval function
from within a MATLAB
Function block.

• coder.ceval function
• “Integrate C Code Using the MATLAB

Function Block”
• MATLAB Function block

5 The application requires
more entry-point functions
than the code generator
typically produces—for
example, more than
model_step,
model_initialize, and
model_terminate. You
want maximum flexibility
for controlling what code
the code generator
produces.

Manually write an S-function
and TLC file.

• “C/C++ S-Function Basics”
• “S-Functions and Code Generation” on

page 13-2
• “C S-Function Examples” and “C++ S-

Function Examples”
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 Condition or
Requirement

Action More Information

6 You want to simulate and
generate external code for
a discrete time application.
Optimizing generated code
is essential. You want ease
of use with moderate
flexibility for controlling
what code the code
generator produces. You
have C or C++
programming experience,
but you prefer to generate
the files for adding the code
to a model.

Generate S-function and TLC
files by using the Legacy
Code Tool. If necessary,
refine the generated code
manually to meet application
requirements. (If you change
the generated code, you lose
the changes if you
regenerate the S-function
and TLC files.)

For simple algorithms
written in C, consider using
the Simulink C Caller block.

• “Integrate C Functions Using Legacy Code
Tool”

• “Import Calls to External Code into
Generated Code with Legacy Code Tool”

• “Integrate C Code Using C Caller Blocks”

7 The algorithm must model
discrete and continuous
state dynamics for
simulation and rapid
prototyping. The external
code requires a fixed-point
interface. Programming
experience is limited. You
want ease of use with basic
flexibility for controlling
what code the code
generator produces for
rapid prototyping.

Generate S-function and TLC
files by using the S-Function
Builder. If necessary, refine
the generated code manually
to meet application
requirements. (If you change
the generated code, you lose
the changes if you
regenerate the S-function
and TLC files.)

• “Use a Bus Signal with S-Function Builder
to Create an S-Function”

• “Generate S-Function from Subsystem” on
page 13-64

Modify Programming Language of External Code to Match Generated Code

To integrate external C code with generated C++ code or conversely, modify the language of the
external code to match the programming language choice for the generated code. Options for making
the programming language match include:

• Writing or rewriting the external code in the language choice for the generated code.
• If you are generating C++ code and the external code is C code, for each C function, create a

header file that prototypes the function. Use this format:
#ifdef __cplusplus
extern "C" {
#endif
int my_c_function_wrapper();
#ifdef __cplusplus
}
#endif

The prototype serves as a function wrapper. If your compiler supports C++ code, the value
__cplusplus is defined. The linkage specification extern "C" specifies C linkage without name
mangling.

• If you are generating C code and the external code is C++ code, include an extern "C" linkage
specification in each .cpp file. For example, the following example shows C++ code in the file
my_func.cpp:
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extern "C" {

int my_cpp_function()
{
  ...
}
}

Integration Approaches for External Fortran Code

To integrate external Fortran code, write an S-function and corresponding TLC file.

See “C/C++ S-Function Basics”, “Implement Algorithms Using Fortran Code”, “S-Functions and Code
Generation” on page 13-2, and“Fortran S-Function Examples”.

Insert External Code into Stateflow Charts
• “Integrate External Code for Library Charts” on page 56-23
• “Integrate External Code for All Charts” on page 56-24
• “Call External C Code from Model and Generated Code” on page 56-24

Integrate External Code for Library Charts

To integrate external code that applies only to Stateflow library charts for code generation, for each
library model that contributes a chart to your main model, complete these steps. Then, generate
code.

1 In the Stateflow Editor, open the Model Configuration Parameters dialog box. Select parameter
Use local custom code settings (do not inherit from main model),

The library model retains its own custom code settings during code generation.
2 Specify your custom code in the subpanes.

Follow the guidelines in “Specify Relative Paths to Your Custom Code” (Stateflow).

If you specified custom code settings for simulation, you can apply these settings to code
generation. To avoid entering the same information twice, select Use the same custom code
settings as Simulation Target.

3 Click OK.

After completing these steps for each library model, generate code.
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Integrate External Code for All Charts

To integrate external code that applies to all charts for code generation:

1 Specify custom code options for code generation of your main model.

a In the Model Configuration Parameters dialog box, select Code Generation > Custom
Code.

b In the custom code text fields, specify your custom code.

Follow the guidelines in “Specify Relative Paths to Your Custom Code” (Stateflow).

If you specified custom code settings for simulation, you can apply these settings to code
generation. To avoid entering the same information twice, select Use the same custom
code settings as Simulation Target.

2 Configure code generation for each library model that contributes a chart to your main model. In
the Stateflow Editor, open the Model Configuration Parameters dialog box. Clear parameter Use
local custom code settings (do not inherit from main model). The library charts inherit the
custom code settings of your main model. Click OK.

3 Generate code.

Call External C Code from Model and Generated Code

Call existing, external functions from a simulation or from the generated code by using the Legacy
Code Tool.

Learn how to:

• Evaluate a C function as part of a Simulink® model simulation.
• Call a C function from the code that you generate from a model.

For information about the example model, see “Prepare a Control Algorithm Model for C Code
Generation” on page 51-18.

Replacement Process

Open the example model, rtwdemo_PCG_Eval_P4.

For many Model-Based Design applications, in addition to Simulink® models, a design includes a set
of existing C functions that have been tested and validated. You can integrate these functions into a
Simulink® model and generate code that uses the functions.

In this example, you create a custom Simulink® block that calls an existing C function. You then
include the block in a model and test the overall system through model simulation in Simulink®.

In the example model, you can replace the Lookup blocks (lookup tables) in the PI controllers with
calls to an existing C function. The function is defined in files SimpleTable.c and SimpleTable.h.

View SimpleTable.c.

View SimpleTable.h.
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Create Block That Calls C Function

To specify a call to an existing C function, use an S-Function block. You can automate the creation of
the S-Function block by using the Legacy Code Tool. In the tool, you first specify an interface for your
existing C function. The tool then uses that interface to create an S-Function block.

Use the Legacy Code Tool to create an S-Function block for the existing C function in
SimpleTable.c.

1. Create a structure to contain the definition of the function interface.

def = legacy_code('initialize')

You can use the structure def to define the function interface to the existing C code.

2. Populate the fields of the structure.

3. Create the S-function.

legacy_code('sfcn_cmex_generate',def)

4. Compile the S-function.

legacy_code('compile',def)

5. Create the S-Function block.

legacy_code('slblock_generate',def)

The generated S-Function block calls the C function in SimpleTable.c. You can now use this S-
Function block in models.

6. Create the TLC file.
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legacy_code('sfcn_tlc_generate',def)

This command creates a TLC file, which is the component of an S-Function that specifies how to
generate code for the block.

Validate External Code Through Simulation

When you integrate existing C code in a Simulink® model, validate the generated S-Function block.

To validate the replacement of the Lookup blocks, compare the simulation results produced by the
Lookup blocks with the results produced by the new S-Function block.

1. Open the validation model.

• The Sine Wave block produces output values from [-2 : 2].
• The input range of the lookup table is from [-1 : 1].
• The lookup table outputs the absolute value of the input.
• The lookup table clips the output at the input limits.

2. Run the validation model.

The figure shows the validation results. The existing C code and the Simulink® table block produce
the same output values.
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Validate C Code as Part of Simulink® Model

After validating the existing C function code as a standalone component, validate the S-function in
the model. To complete the validation, use a test harness model.

1. Open the test harness.

2. Run the test harness.

The simulation results match the golden values.
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Call C Function from the Generated Code

The code generator uses the TLC file to process the S-Function block like any other block. The code
generator can implement expression folding with the S-Function block, an operation that combines
multiple computations into a single output calculation.

1. Build the full model.

2. Examine the generated code in PI_Control_Reusable.c.

The generated code now calls the SimpleTable C function.

The figures show the generated code before and after the C code integration. Before the integration,
the code calls a generated lookup routine. After the integration, the generated code calls the C
function SimpleTable.
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See Also

More About
• “Integrate C Functions Using Legacy Code Tool”
• “Import Calls to External Code into Generated Code with Legacy Code Tool”
• “Custom Code” (Stateflow)
• “Integrate C Code Using the MATLAB Function Block”
• “C/C++ S-Function Basics”
• “S-Functions and Code Generation” on page 13-2
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Place External C/C++ Code in Generated Code

In this section...
“Workflow” on page 56-30
“Choose an Integration Approach” on page 56-31
“Integrate External Code by Using Custom Code Blocks” on page 56-32
“Integrate External Code by Using Model Configuration Parameters” on page 56-34
“Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model
Configuration Parameters” on page 56-35

You can customize code that the code generator produces for a model by specifying external code
with custom code blocks or model configuration parameters.

• Place code at the start and end of the generated code for the root model.
• Place declaration, body, and exit code in generated function code for blocks in the root model or

nonvirtual subsystems.

The functions that you can augment with external code depends on the functions that the code
generator produces for blocks that are in the model. For example, if a model or atomic subsystem
includes blocks that have states, you can specify code for a disable function. Likewise, if you need the
code for a block to save data, free memory, or reset target hardware, specify code for a terminate
function. For more information, see “Block Target File Methods”.

Workflow
To place external C or C++ code at specific locations in code that the code generator produces for
root models and subsystems, iterate through the tasks listed in this table.

Task Action More Information
1 If you want to integrate external C code

with generated C++ code or conversely,
modify the language of the external code
to match the language choice for the
generated code.

“Modify Programming Language of External Code
to Match Generated Code”

2 Review your assessment of external code
characteristics and integration
requirements.

“Choose an External Code Integration Workflow”
on page 56-3

3 If necessary, rewrite code in C or C++.  
4 Choose an integration approach to add

the external code to a Simulink model.
“Choose an Integration Approach” on page 56-31

5 Define the representation of model data
for code generation.

“Exchange Data Between External C/C++ Code
and Simulink Model or Generated Code” on page
56-69

6 Configure the model for code generation. “Generate Code That Matches Appearance of
External Code” on page 56-80 and “Model
Configuration”
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Task Action More Information
7 Generate code and a code generation

report.
“Code Generation”

8 Review the generated code interface and
static code metrics.

“Analyze the Generated Code Interface” on page
52-13 and “Static Code Metrics” on page 52-23

9 Build an executable program from the
model.

“Build Integrated Code Within the Simulink
Environment” on page 56-40

10 Verify that executable program performs
as expected.

“Numerical Equivalence Testing” and “Code
Execution Profiling”

Choose an Integration Approach
Within the Simulink modeling environment, two approaches are available for placing external C or C
++ code into sections of code that the code generator produces:

• Add blocks from the Custom Code library to a root model or atomic subsystem.
• Set model configuration parameters on the Code Generation > Custom Code pane.

The following table compares the two approaches. Choose the approach that aligns best with your
integration requirements. For more information about how to apply each approach, see “Integrate
External Code by Using Custom Code Blocks” on page 56-32 and “Integrate External Code by Using
Model Configuration Parameters” on page 56-34.

Requirement Blocks Model Configuration
Parameters

Include a representation of your external code in the
modeling canvas

✓  

Place code in functions generated for root models ✓ ✓

Place code in functions generated for atomic
subsystems

✓  

Save code placement in a model configuration set  ✓

Place code at the top and bottom of the header and
source files generated for a model

✓ ✓

Place code within declaration, execution, and exit
sections of the SystemInitialize
andSystemTerminate functions that the code
generator creates

✓ ✓

Place code within declaration, execution, and exit
sections of the SystemStart, SystemEnable,
SystemDisable, SystemOutputs, SystemUpdate,
orSystemDerivatives functions that the code
generator creates

✓  

Add preprocessor macro definitions to generated code  ✓

Use the custom code settings that are specified for the
simulation target

 ✓
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Requirement Blocks Model Configuration
Parameters

Configure a library model to use custom code settings
of the parent model to which the library is linked

 ✓

Integrate External Code by Using Custom Code Blocks
• “Custom Code Block Library” on page 56-32
• “Add Custom Code Blocks to the Modeling Canvas” on page 56-33
• “Add External Code to Generated Start Function” on page 56-33

Custom Code Block Library

The Custom Code block library contains blocks that you can use to place external C or C++ code into
specific locations and functions within code that the code generator produces. The library consists of
10 blocks that add your code to the model header (model.h) and source (model.c or model.cpp)
files that the code generator produces.

The Model Header and Model Source blocks add external code at the top and bottom of header and
source files that the code generator produces for a root model. These blocks display two text fields
into which you can type or paste code. One field specifies code that you want to place at the top of the
generated header or source file. The second field specifies code that you want to place at the bottom
of the file.

The remaining blocks add external code to functions that the code generator produces for the root
model or atomic subsystem that contains the block. The blocks display text fields into which you can
type or paste code that customizes functions that the code generator produces. The text fields
correspond to the declaration, execution, and exit sections of code for a given function.

To Customize Code That Use This Block
Computes continuous states System Derivatives
Disables state System Disable
Enables state System Enable
Resets state System Initialize
Produces output System Outputs
Executes once System Start
Saves data, free memory, reset target hardware System Terminate
Requires updates at each major time step System Update

The block and its location within a model determines where the code generator places the external
code. For example, if the System Outputs block is at the root model level, the code generator places
the code in the model Outputs function. If the block resides in a triggered or enabled subsystem, the
code generator places the code in the subsystem Outputs function.

If the code generator does not need to generate a function that corresponds to a Custom Code block
that you include in a model, the code generator does one of the following:

• Omits the external code that you specify in the Custom Code block.
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• Returns an error, indicating that the model does not include a relevant block. In this case, remove
the Custom Code block from the model.

For more information, see “Block Target File Methods”.

Note To avoid a potential mismatch between simulation and code generation results, do not use
custom code blocks to read from and write to global Simulink data (signals, states, and block
parameters). Instead, use the proper modeling pattern (for example, Data Store Read, Data Store
Write, State Reader, and State Writer blocks.)

Add Custom Code Blocks to the Modeling Canvas

To add the Custom Code library blocks to a model:

1 In the Simulink Library Browser, open the Custom Code block library.
2 Drag the blocks that you want into your model or subsystem. Drag Model Header and Model

Source blocks into root models only. Drag function-based Custom Code blocks into root models or
atomic subsystems.

You can use models that contain Custom Code blocks as referenced models. The code generator
ignores the blocks when producing code for a simulation target. When producing code for a code
generation target, the code generator includes and compiles the custom code.

Add External Code to Generated Start Function

This example shows how to use the System Start block to place external C code in the code that the
code generator produces for a model that includes a discrete filter.

1 Create the following model.

2 Configure the model for code generation.
3 Double-click the System Start block.
4 In the block parameters dialog box, in the System Start Function Declaration Code field,

enter this code:

unsigned int *ptr = 0xFFEE;
5 In the System Start Function Execution Code field, enter this code:

/* Initialize hardware */
*ptr = 0;

6 Click OK.
7 Generate code and a code generation report.
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8 View the generated model.c file. Search for the string start function. You should find the
following code, which includes the external code that you entered in steps 4 and 5.
  {
    {
      /* user code (Start function Header) */
      /* System '<Root>' */
      unsigned int *ptr = 0xFFEE;
  
      /* user code (Start function Body) */
      /* System '<Root>' */
      /* Initialize hardware */
      *ptr = 0;
    }
  }

For another example, see “Integrate External C Code Into Generated Code By Using Custom Code
Blocks and Model Configuration Parameters” on page 56-35.

Integrate External Code by Using Model Configuration Parameters
Model configuration parameters provide a way to place external C or C++ code into specific locations
and functions within code that the code generator produces.

To Select
Insert external code near
the top of the generated
model.c or model.cpp file

Source file, and enter the external code to insert.

If you generate subsystem code into separate files, that code does not have access
to external code that you specify with the Source file parameter. For example, if
you specify an include file as a Source file setting, the code generator inserts the
#include near the top of the model.c or model.cpp file. The subsystem code
that the code generator places in a separate file does not have access to
declarations inside your included file. In this case, consider specifying your
external code with the Header file parameter.

Insert external code near
the top of the generated
model.h file

Header file, and enter the external code to insert.

Insert external code inside
the model initialize function
in the model.c or
model.cpp file

Initialize function, and enter the external code to insert.

Insert external code inside
the model terminate
function in the model.c or
model.cpp file

Terminate function, and enter the external code to insert. Also select the
Terminate function required parameter on the Interface pane.

Add preprocessor macro
definitions

Defines, and enter a space-separated list of preprocessor macro definitions to
add to the generated code. The list can include simple definitions (for example, -
DEF1) and definitions with a value (for example, -DDEF2=1). Definitions can omit
the -D (for example, -DFOO=1 and FOO=1 are equivalent). If a definition includes
-D, the toolchain can override the flag if the toolchain uses a different flag for
defines.
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To Select
Use the same custom code
parameter settings as the
settings specified for
simulation of MATLAB
Function blocks, Stateflow
charts, and Truth Table
blocks

Use the same custom code settings as Simulation Target

This parameter refers to the Simulation Target pane in the Configuration
Parameters dialog box.

Enable a library model to
use custom code settings
unique from the parent
model to which the library
is linked

Use local custom code settings (do not inherit from main model)

This parameter is available only for library models that contain MATLAB Function
blocks, Stateflow charts, or Truth Table blocks.

To include a header file in an external header file, add #ifndef code. Using this code avoids multiple
inclusions. For example, in rtwtypes.h, the following #include guards are added:

#ifndef RTW_HEADER_rtwtypes_h_ 
#define RTW_HEADER_rtwtypes_h_ 
... 
#endif /* RTW_HEADER_rtwtypes_h_ */

For more information on how to add files names and locations of header, source, and shared library
files to the build process, see “Build Integrated Code Within the Simulink Environment” on page 56-
40.

Note The code generator includes external code that you include in a configuration set when
generating code for software-in-the-loop (SIL) and processor-in-the-loop (PIL) simulations. However,
the code generator ignores external code that you include in a configuration set when producing code
with the S-function, rapid simulation, or simulation system target file.

For more information about Custom Code parameters, see “Model Configuration Parameters: Code
Generation Custom Code”. For an example, see “Integrate External C Code Into Generated Code By
Using Custom Code Blocks and Model Configuration Parameters” on page 56-35.

Integrate External C Code Into Generated Code By Using Custom Code
Blocks and Model Configuration Parameters
This example shows how to place external code in generated code by using custom code blocks and
model configuration parameters.

1. Open the model rtwdemo_slcustcode.

open_system('rtwdemo_slcustcode')
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2. Open the Simulink Coder or Embedded Coder app.

3. Open the Model Configuration Parameters dialog box and navigate to the Custom Code pane.

4. Examine the settings for model configuration parameters Source file and Initialize function.

• Source file specifies a comment and sets the variable GLOBAL_INT2 to -1.
• Initialize function initializes the variable GLOBAL_INT2 to 1.

5. Close the dialog box.

6. Double-click the Model Source block. Block parameter Top of Model Source specifies that the
code generator declare the variable GLOBAL_INT1 and set it to 0 at the top of the generated file
rtwdemo_slcustcode.c.

7. Open the triggered subsystem Amplifier. The subsystem includes the System Outputs block. The
code generator places code that you specify in that block in the generated code for the nearest parent
atomic subsystem. In this case, the code generator places the external code in the generated code for
the Amplifier subsystem. The external code:

• Declares the pointer variable *intPtr and initializes it with the value of variable GLOBAL_INT1.
• Sets the pointer variable to -1 during execution.
• Resets the pointer variable to 0 before exiting.

8. Generate code and a code generation report.

9. Examine the code in the generated source file rtwdemo_slcustcode.c. At the top of the file,
after the #include statements, you find the following declaration code. The example specifies the
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first declaration with the Source file configuration parameter and the second declaration with the
Model Source block.

int_T GLOBAL_INT2 = -1;

int_T GLOBAL_INT1 = 0;

The Output function for the Amplifier subsystem includes the following code, which shows the
external code integrated with generated code that applies the gain. The example specifies the three
lines of code for the pointer variable with the System Outputs block in the Amplifier subsystem.

int_T *intPtr = &GLOBAL_INT1;

*intPtr = -1;

rtwdemo_slcustcode_Y.Output = rtwdemo_slcustcode_U.Input << 1;

*intPtr = 0;

The following assignment appears in the model initialize entry-point function. The example specifies
this assignment with the Initialize function configuration parameter.

GLOBAL_INT2 = 1;

See Also

More About
• “Configure Model and Generate Code”
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Call External Device Drivers
Device drivers for protocols and target hardware are essential to many real-time development
projects. For example, you can have a working device driver that you want to integrate with
algorithmic code that has to read data from and write data to the I/O device that the driver supports.
The code generator can produce a single set of application source files from an algorithm model and
integrated driver code written in C or C++.

To call external device driver code from the Simulink environment, iterate through the tasks in this
table.

Task Action More Information
1 Review your assessment of external code

characteristics and integration
requirements.

“Choose an External Code Integration Workflow”
on page 56-3

2 Define the representation of model data
for code generation.

“Exchange Data Between External C/C++ Code
and Simulink Model or Generated Code” on page
56-69

3 Generate S-function and TLC files by
using the Legacy Code Tool. If necessary,
refine the generated code manually to
meet application requirements.

• “Integrate C Functions Using Legacy Code
Tool”

• “Import Calls to External Code into Generated
Code with Legacy Code Tool”

4 Verify algorithm behavior and
performance by simulating the model.

“Simulation”

5 Configure the model for code generation. “Generate Code That Matches Appearance of
External Code” on page 56-80 and “Model
Configuration”

6 Generate code and a code generation
report.

“Code Generation”

7 Review the generated code interface and
static code metrics.

“Analyze the Generated Code Interface” on page
52-13 and “Static Code Metrics” on page 52-23

8 Build an executable program from the
model.

“Build Integrated Code Within the Simulink
Environment” on page 56-40

9 Verify that executable program behaves
and performs as expected.

“Numerical Equivalence Testing”

10 Verify that executable program performs
as expected.

“Code Execution Profiling”

See Also

More About
• “Integrate C Functions Using Legacy Code Tool”
• “Import Calls to External Code into Generated Code with Legacy Code Tool”
• “Custom Targets”
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Apply Function and Operator Code Replacements
If your generated code must use functions and operators that are consistent with external code,
configure the code generator to use a code replacement library (CRL). By default, the code generator
does not apply a code replacement library. You can choose from several libraries that MathWorks
provides, including GNU C99 extensions, AUTOSAR 4.0, and several Intel® platform-specific IPP and
IPP/SSE libraries. Depending on the products that you have, other libraries might be available. If you
have Embedded Coder software, you can view and choose from additional libraries and you can
create custom code replacement libraries.

See Also

More About
• “What Is Code Replacement?” on page 54-2
• “What Is Code Replacement Customization?” on page 67-3
• Code Replacement Viewer
• Code Replacement Tool
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Build Integrated Code Within the Simulink Environment

Workflow
To build executable programs that integrate generated code and external C or C++ code, iterate
through the tasks in this table.

Task Action More Information
1 Choose whether to use the toolchain

approach or template makefile approach
build process.

“Choose Build Approach and Configure Build
Process” on page 57-11

For an example, see “Build Process Workflow for
Real-Time Systems” on page 57-25.

2 Configure build process support for your
external code.

“Configure Parameters for Integrated Code Build
Process” on page 56-40

3 Configure S-Function build support for
your external code.

“Build Support for S-Functions” on page 56-42

“Use makecfg to Customize Generated Makefiles
for S-Functions” on page 85-16

For examples, see “Call External C Code from
Model and Generated Code” on page 51-47 and
“Call Reusable External Algorithm Code for
Simulation and Code Generation” on page 56-15.

4 Configure build process to find the
external code source, library, and header
files.

“Manage Build Process File Dependencies” on
page 50-41

“Control Library Location and Naming During
Build” on page 85-3

5 Set up custom build processing required
for your external code integration.

For the build process customization workflow, see
“Customize Post-Code-Generation Build
Processing” on page 85-8.

To automate applying build customizations to a
toolchain approach build, see “Customize Build
Process with sl_customization.m” on page 85-40.

To automate applying build customizations to a
template makefile approach build, see “Customize
Build Process with STF_make_rtw_hook File” on
page 85-36.

Configure Parameters for Integrated Code Build Process
The table provides a guide to model configuration parameters on Code Generation > Custom Code
pane of the Model Configuration Parameters dialog box that support the build process for external
code integration. For information about folders for your external code, see “Manage Build Process
Folders” on page 50-30. If you choose to place your external code in the “Code generation folder”, see
“Preserve External Code Files in Build Folder” on page 56-41.
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To Select
Add include folders, which
contain header files, to the
build process

Additional build information > Include directories, and enter the
absolute or relative paths to the folders.

If you specify relative paths, the paths must be relative to the folder
containing your model files, not relative to the build folder. The order
in which you specify the folders is the order in which they are
searched for header, source, and library files.

Add source files to be
compiled and linked

Additional build information > Source files, and enter the full
paths or just the file names for the files.

Enter just the file name if the file is in the current MATLAB folder or
in one of the include folders. For each additional source that you
specify, the build process expands a generic rule in the template
makefile for the folder in which the source file is located. For
example, if a source file is located in folder inc, the build process
adds a rule similar to the following:

%.obj: buildir\inc\%.c
            $(CC) -c -Fo$(@F) $(CFLAGS) $<

The build process adds the rules in the order that you list the source
files.

Add libraries to be linked Additional build information > Libraries, and enter the full paths
or just the file names for the libraries.

Enter just the file name if the library is located in the current
MATLAB folder or in one of the include folders.

Use the same custom code
settings as those specified
for simulation of MATLAB
Function blocks, Stateflow
charts, and Truth Table
blocks

Use the same custom code settings as Simulation Target

This parameter refers to the Simulation Target pane in the
Configuration Parameters dialog box.

Enable a library model to use
custom code settings unique
from the parent model to
which the library is linked

Use local custom code settings (do not inherit from main
model)

This parameter is available only for library models that contain
MATLAB Function blocks, Stateflow charts, or Truth Table blocks.

Preserve External Code Files in Build Folder
By default, the build process deletes foreign source files. You can preserve foreign source files by
following these guidelines.

If you put a .c/.cpp or .h source file in a build folder, and you want to prevent the code generator
from deleting it during the TLC code generation process, insert the text target specific file in
the first line of the .c/.cpp or .h file. For example:
/*  COMPANY-NAME target specific file
 *
 *   This file is created for use with the 
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 *   COMPANY-NAME target.
 *   It is used for ...
 */
...

Make sure that you spell the text “target specific file” as shown in the preceding example, and that
the text is in the first line of the source file. Other text can appear before or after this text.

Flagging user files in this manner prevents postprocessing these files to indent them with generated
source files. Auto-indenting occurred in previous releases to build folder files with names having the
pattern model_*.c/.cpp (where * was text). The indenting is harmless, but can cause differences
detected by source control software that can potentially trigger unnecessary updates.

Build Support for S-Functions
User-written S-Function blocks provide a powerful way to incorporate external code into the Simulink
development environment. In most cases, you use S-functions to integrate existing external code with
generated code. Several approaches to writing S-functions are available:

• “Write Noninlined S-Function” on page 13-95
• “Write Wrapper S-Function and TLC Files” on page 13-97
• “Write Fully Inlined S-Functions” on page 13-104
• “Write Fully Inlined S-Functions with mdlRTW Routine” on page 13-106
• “S-Functions for Code Reuse” on page 13-85
• “S-Functions for Multirate Multitasking Environments” on page 13-90

S-functions also provide the most flexible and capable way of including build information for legacy
and custom code files in the build process.

There are different ways of adding S-functions to the build process.

Implicit Build Support

When building models with S-functions, the build process adds rules, include paths, and source file
names to the generated makefile. The source files (.h, .c, and .cpp) for the S-function must be in
the same folder as the S-function MEX-file. Whether using the toolchain approach or template
makefile approach for builds, the build process propagates this information through the toolchain or
template makefile.

• If the file sfcnname.h exists in the same folder as the S-function MEX-file (for example,
sfcnname.mexext), the folder is added to the include path.

• If the file sfcnname.c or sfcnname.cpp exists in the same folder as the S-function MEX-file, the
build process adds a makefile rule for compiling files from that folder.

• When an S-function is not inlined with a TLC file, the build process must compile the S-function
source file. To determine the name of the source file to add to the list of files to compile, the build
process searches for sfcnname.cpp on the MATLAB path. If the source file is found, the build
process adds the source file name to the makefile. If sfcnname.cpp is not found on the path, the
build process adds the file name sfcnname.c to the makefile, whether or not it is on the MATLAB
path.

Note For the Simulink engine to find the MEX-file for simulation and code generation, it must
exist on the MATLAB path or exist in our current MATLAB working folder.
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Specify Additional Source Files for an S-Function

If your S-function has additional source file dependencies, you must add the names of the additional
modules to the build process. Specify the file names:

• In the S-function modules field in the S-Function block parameter dialog box
• With the SFunctionModules parameter in a call to the set_param function

For example, suppose you build your S-function with multiple modules.
mex sfun_main.c sfun_module1.c sfun_module2.c

You can then add the modules to the build process by doing one of the following:

• In the S-function block dialog box, specify sfun_main, sfun_module1, and sfun_module2 in
the S-function modules field.

• At the MATLAB command prompt, enter:
set_param(sfun_block,'SFunctionModules','sfun_module1 sfun_module2')

Alternatively, you can define a variable to represent the parameter value.
modules = 'sfun_module1 sfun_module2'
          set_param(sfun_block,'SFunctionModules', modules)

The S-function modules field and SFunctionModules parameter do not support complete source
file path specifications. To use the parameter, the code generator must find the additional source files
when executing the makefile. For the code generator to locate the additional files, place them in the
same folder as the S-function MEX-file. You can then leverage the implicit build support described in
“Implicit Build Support” on page 56-42.

When you are ready to generate code, force the code generator to rebuild the top model, as described
in “Control Regeneration of Top Model Code”.

For more complicated S-function file dependencies, such as specifying source files in other locations
or specifying libraries or object files, use the rtwmakecfg.m API, as described in “Use rtwmakecfg.m
API to Customize Generated Makefiles” on page 85-18.

Use TLC Library Functions

If you inline your S-function by writing a TLC file, you can add source file names to the build process
by using the TLC library function LibAddToModelSources. For details, see
“LibAddSourceFileCustomSection(file, builtInSection, newSection)”.

Note This function does not support complete source file path specifications. The function assumes
that the code generator can find the additional source files when executing the makefile.

Another useful TLC library function is LibAddToCommonIncludes. Use this function in a #include
statement to include S-function header files in the generated model.h header file. For details, see
“LibAddToCommonIncludes(incFileName)”.

For more complicated S-function file dependencies, such as specifying source files in other locations
or specifying libraries or object files, use the rtwmakecfg.m API, as described in “Use rtwmakecfg.m
API to Customize Generated Makefiles” on page 85-18.
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Precompile S-Function Libraries

You can precompile new or updated S-function libraries (MEX-files) for a model by using the MATLAB
language function rtw_precompile_libs. Using a specified model and a library build specification,
this function builds and places the libraries in a precompiled library folder.

By precompiling S-function libraries, you can optimize system builds. Once your precompiled libraries
exist, the build process can omit library compilation from subsequent builds. For models that use
numerous libraries, the time savings for build processing can be significant.

To use rtw_precompile_libs:

1 Set the library file suffix, including the file type extension, based on your system platform.

Consider determining the type of platform, and then use the TargetLibSuffix parameter to
set the library suffix accordingly. For example, when applying a suffix for a GRT target, you can
set the suffix to _std.a for a UNIX platform and _vcx64.lib for a Windows platform.
  if isunix
    suffix = '_std.a';
  else
    suffix = '_vcx64.lib';
  end

set_param(my_model,'TargetLibSuffix', suffix);

There are a number of factors that influence the precompiled library suffix and extension. The
following table provides examples for typical selections of system target file, the compiler
toolchain, and other options that affect your choice of suffix and extension. For more information,
examine the template make files in the matlab/rtw/c/grt folder or matlab/rtw/c/ert
folder.

TMF File COMPILER
_TOOL_CHAIN

Value

Precompiler Libraries (PRECOMP_LIBRARIES)
Library Suffix

S-Function
(EXPAND
_LIBRARY

_NAME Value)

Library Suffix
Integer- Only

Code (EXPAND
_LIBRARY

_NAME Value)

Library Suffix
Optimize for

Speed (EXPAND
_LIBRARY

_NAME Value)

Library
Extension
(EXPAND
_LIBRARY

_NAME Value)
ert_lcc64.tmf lcc _rtwsfcn_lcc _int_ert_lcc _ert_lcc .lib
ert_vcx64.tmf vcx64 _rtwsfcn_vcx64 _int_ert_vcx64 _ert_vcx64 .lib
ert_unix.tmf unix _rtwsfcn _int_ert _ert .a
grt_lcc64.tmf lcc n/a n/a _lcc .lib
grt_vcx64.tmf vcx64 n/a n/a _vcx64 .lib
grt_unix.tmf unix n/a n/a _std .a

2 Set the precompiled library folder.

Use one of the following methods to set the precompiled library folder:

• Set the TargetPreCompLibLocation parameter, as described in “Specify the Location of
Precompiled Libraries” on page 85-4.

• Set the makeInfo.precompile field in an rtwmakecfg.m function file. (For more
information, see “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 85-18.)
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If you set TargetPreCompLibLocation and makeInfo.precompile, the setting for
TargetPreCompLibLocation takes precedence.

The following command sets the precompiled library folder for model my_model to folder lib
under the current working folder.
set_param(my_model,'TargetPreCompLibLocation', fullfile(pwd,'lib'));

Note If you set both the target folder for the precompiled library files and a target library file
suffix, the build process detects whether any precompiled library files are missing while
processing builds.

3 Define a build specification.

Set up a structure that defines a build specification. The following table describes fields that you
can define in the structure. These fields are optional, except for rtwmakecfgDirs.

Field Description
rtwmakecfgDirs A cell array of character vectors that name the folders containing rtwmakecfg

files for libraries to be precompiled. The function uses the Name and Location
elements of makeInfo.library, as returned by rtwmakecfg, to specify the
name and location of the precompiled libraries. If you set the
TargetPreCompLibLocation parameter to specify the library folder, that
setting overrides the makeInfo.library.Location setting.

Note: The specified model must contain blocks that use precompiled libraries
specified by the rtwmakecfg files because the TMF-to-makefile conversion
generates the library rules only if the build process uses the libraries.

libSuffix A character vector that specifies the suffix, including the file type extension, to
be appended to the name of each library (for example, .a or _vc.lib). The
character vector must include a period (.). You must set the suffix with either
this field or the TargetLibSuffix parameter. If you specify a suffix with both
mechanisms, the TargetLibSuffix setting overrides the setting of this field.

intOnlyBuild A Boolean flag. When set to true, the flag indicates the libraries are to be
optimized such that they are compiled from integer code only. This field applies
to ERT targets only.

makeOpts A character vector that specifies an option to be included in the rtwMake
command line.

addLibs A cell array of structures that specify libraries to be built that are not specified
by an rtwmakecfg function. Each structure must be defined with two fields
that are character arrays:

• libName — the name of the library without a suffix
• libLoc — the location for the precompiled library

The target makefile (TMF) can specify other libraries and how those libraries
are built. Use this field to precompile those libraries.

The following commands set up build specification build_spec, which indicates that the files to
be compiled are in folder src under the current working folder.
build_spec = [];
build_spec.rtwmakecfgDirs = {fullfile(pwd,'src')};
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4 Issue a call to rtw_precompile_libs.

The call must specify the model for which you want to build the precompiled libraries and the
build specification. For example:
rtw_precompile_libs(my_model,build_spec);

See Also

More About
• “Call Reusable External Algorithm Code for Simulation and Code Generation” on page 56-15
• “Place External C/C++ Code in Generated Code” on page 56-30
• “Call External Device Drivers” on page 56-38
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Deploy Generated Component Software to Application Target Platforms” on page 66-26
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Generate Component Source Code for Export to External Code
Base

In this section...
“Modeling Options” on page 56-47
“Requirements” on page 56-47
“Limitations for Export-Function Subsystems” on page 56-49
“Workflow” on page 56-49
“Choose an Integration Approach” on page 56-50
“Generate C Function Code for Export-Function Model” on page 56-51
“Generate C++ Function and Class Code for Export-Function Model” on page 56-54
“Generate Code for Export-Function Subsystems” on page 56-59

If you have Embedded Coder software, you can generate function source code from modeling
components to use in an external code base. The generated code does not include supporting
scheduling code (for example, a step function). Controlling logic outside of the Simulink environment
invokes the generated function code.

Modeling Options
You can generate function code to export for these modeling components:

• Export-function models (model containing functional blocks that consist exclusively of function-
call subsystems, function-call model blocks, or other export-function models, as described in
“Export-Function Models Overview”)

• Export-function subsystems (virtual subsystem that contains function-call subsystems)

To export code that the code generator produces for these modeling components, the modeling
components must meet specific requirements on page 56-47.

For models designed in earlier releases, the code generator can export functions from triggered
subsystems. The requirements stated for export-function subsystems also apply to exporting functions
from triggered subsystems, with the following exceptions:

• Encapsulate triggered subsystems from which you intend to export functions in a top-level virtual
subsystem.

• Triggered subsystems do not have to meet requirements and limitations identified for virtual
subsystems that contain function-call subsystem.

• “Export Functions That Use Absolute or Elapsed Time” on page 56-48 does not apply to
exporting functions from triggered subsystems.

Requirements
• Model solver must be a fixed-step discrete solver.
• You must configure each root-level Inport block that triggers a function-call subsystem to output a

function-call trigger. These Inport blocks cannot connect to an Asynchronous Task Specification
block.
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• Model or subsystem, must contain only the following blocks at the root level:

• Function-call blocks (such as Function-Call Subsystem, Simulink Function, S-Functions, and
Function-Call Model blocks at the root level if the solver model configuration parameter
Tasking and sample time options > Periodic sample time constraint is set to Ensure
sample time independent)

• Inport and Outport blocks (ports)
• Constant blocks (including blocks that resolve to constants, such as Add)
• Blocks with a sample time of Inf
• Merge and data store memory blocks
• Virtual connection blocks (such as, Function-Call Split, Mux, Demux, Bus Creator, Bus Selector,

Signal Specification, and virtual subsystems that contain these blocks)
• Signal-viewer blocks, such as Scope blocks (export-function subsystems only)

• When a constant block appears at the top level of the model or subsystem, you must set the model
configuration parameter Optimization > Default parameter behavior for the model or
containing model to Inlined.

• Blocks inside the model or subsystem must support code generation.
• Blocks that use absolute or elapsed time must be inside a periodic function-call subsystem with a

discrete sample time specified on the corresponding function-call root-level Inport block. See
“Export Functions That Use Absolute or Elapsed Time” on page 56-48.

• Data signals that cross the boundary of an exported system cannot be a virtual bus and cannot be
implemented as a Goto-From connection. Data signals that cross the export boundary must be
scalar, muxed, or a nonvirtual bus.

In addition, for export-function models, you cannot generate code for a rate-based model that
includes multiple instances of an export-function model. For example, you cannot generate code for a
test harness model that you use for scheduling reusable export-function models during simulation.

For export-function subsystems, the following additional requirements apply:

• A trigger signal that crosses the boundary of an export-function subsystem must be scalar. Input
and output data signals that do not act as triggers do not have to be scalar.

• When a constant signal drives an output port of an export-function subsystem, the signal must
specify a storage class.

Export Functions That Use Absolute or Elapsed Time

If you want to export function code for a modeling component with blocks that use absolute or
elapsed time, those blocks must be inside a function-call subsystem that:

• You configure for periodic execution
• You configure the root-level Inport block with a discrete sample time

To configure a function-call subsystem for periodic execution:

1 In the function-call subsystem, right-click the Trigger block and choose Block Parameters from
the context menu.

2 Set parameter Sample time type to periodic.
3 Set Sample time to the same granularity specified (directly or by inheritance) in the function-

call initiator.
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4 Click OK or Apply.

For more information, see “Absolute and Elapsed Time Computation”.

Limitations for Export-Function Subsystems
• Subsystem block parameters do not control the names of the files containing the generated code.

The file names begin with the name of the exported subsystem.
• Subsystem block parameters do not control the names of top-level functions in the generated

code. Each function name reflects the name of the signal that triggers the function or (for an
unnamed signal) reflects the block from which the signal originates.

• You can export function-call systems for the C++ class code interface packaging only when its
function specification is set to Default step method. See “Interactively Configure C++ Interface”
on page 42-2. The exported function is compatible with single-threaded execution. To avoid
potential data race conditions for shared signals, invoke all members for the class from the same
execution thread.

• The code generator supports a SIL or PIL block in accelerator mode only if its function-call
initiator is noninlined in accelerator mode. Examples of noninlined initiators include Stateflow
charts.

• A Level-2 S-function initiator block, such as a Stateflow chart or the built-in Function-Call
Generator block, must drive a SIL block.

• You can export an asynchronous (sample-time) function-call system, but the software does not
support the SIL or PIL block for an asynchronous system.

• The use of the TLC function LibIsFirstInit has been removed for export-function subsystems.

Workflow
To generate code for an exported function, iterate through the tasks listed in this table.

Task Action More Information
1 Review your assessment of external code

characteristics and integration
requirements.

“Choose an External Code Integration Workflow”
on page 56-3

2 Verify that the model or subsystem that
you are exporting satisfies function
exporting requirements.

“Requirements” on page 56-47

3 Address data interface requirements by
modifying the model or subsystem.

“Exchange Data Between External C/C++ Code
and Simulink Model or Generated Code” on page
56-69

4 If necessary, configure function
prototype.

“Configure Entry-Point Function Interfaces for
Simulink Function and Function Caller Blocks” on
page 40-2 and, for fixed-step rate-based models,
“Configure C Code Generation for Model Entry-
Point Functions” on page 33-112 or “Interactively
Configure C++ Interface” on page 42-2
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Task Action More Information
5 If necessary , update the model to place

external application-specific code in
generated system functions.

“Place External C/C++ Code in Generated Code”
on page 56-30

6 Verify that the functions behave and
perform as expected during simulation by
creating and using a test harness model.
The test harness model schedules
execution of the functions during
simulation.

“Configure Model, Generate Code, and Simulate”
on page 50-2 and, if you have Simulink Test
software, “Test Authoring” (Simulink Test)

7 Configure the model or subsystem for
code generation.

“Generate Code Using Embedded Coder®” on
page 51-2, “Generate Code That Matches
Appearance of External Code” on page 56-80,
and “Model Configuration”

8 Generate code and a code generation
report.

“Code Generation”

9 Review the generated code interface and
static code metrics.

“Analyze the Generated Code Interface” on page
52-13 and “Static Code Metrics” on page 52-23

10 Build an executable program that
includes the exported function code.

“Build Integrated Code Outside the Simulink
Environment” on page 51-52

11 Verify that executable program behaves
and performs as expected.

 

Choose an Integration Approach
Multiple approaches are available for generating function code for export to an external development
environment. The following table compares approaches. Choose the approach that aligns best with
your integration requirements. For more information on how to create export-function models, see
“Export-Function Models Overview”. For more information on generating code for function call
subsystems, see “Generate Component Source Code for Export to External Code Base” on page 56-
47.

Condition or Requirement Use More Information
• Traceability between modeling

elements and generated code
• Local inputs (Inport block) and

outputs (Outport block)

Function-call
subsystem

• “Generate C Function Code for Export-
Function Model” on page 56-51

• “Generate C++ Function and Class Code for
Export-Function Model” on page 56-54

• “Using Function-Call Subsystems”
• Function-Call Subsystem
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Condition or Requirement Use More Information
• Control over generated function

prototype
• Formal input arguments

(Argument Inport blocks) and
output arguments (Argument
Outport blocks)

• Local inputs (Inport block) and
outputs (Outport block)

Simulink Function
block

• “Configure Entry-Point Function Interfaces
for Simulink Function and Function Caller
Blocks” on page 40-2

• “Simulink Function Blocks and Code
Generation”

• “Generate Code for a Simulink Function and
Function Caller” on page 7-15

• “Simulink Functions”
• Simulink Function

Code responds to an initialization
event

Initialize Function
block

• “Generate C Function Code for Export-
Function Model” on page 56-51

• “Generate C++ Function and Class Code for
Export-Function Model” on page 56-54

• “Generate Code That Responds to Initialize,
Reset, and Terminate Events” on page 11-2

• “Using Initialize, Reset, and Terminate
Functions”

Code responds to a reset event Reset Function block • “Generate C Function Code for Export-
Function Model” on page 56-51

• “Generate C++ Function and Class Code for
Export-Function Model” on page 56-54

• “Generate Code That Responds to Initialize,
Reset, and Terminate Events” on page 11-2

• “Using Initialize, Reset, and Terminate
Functions”

Code includes entry-point functions
beyond what the code generator
produces by default
(model_initialize, model_step,
and model_terminate)

S-function “S-Functions and Code Generation”

Single-model execution framework
to use as test harness and to export
code generated for portions of a
model

Export-function
subsystem

• “Control Generation of Functions for
Subsystems” on page 3-2

• “Using Function-Call Subsystems”
• Function-Call Subsystem

Generate C Function Code for Export-Function Model
This example shows how to generate function code for individual Simulink function blocks and
function-call subsystems in a model without generating scheduling code.

To generate function code for export:

1 Create a model that contains the functions for export.
2 Create a test harness model that schedules execution of the functions during simulation.
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3 Simulate the model that contains the functions by using the test harness model.
4 Generate code for the model that contains the functions.

Create Model That Contains Functions for Export

The model with functions for export must satisfy architectural constraints at the model root level. At
the root level, valid blocks are:

• Inport
• Outport
• Function-Call Subsystem
• Simulink Function
• Goto
• From
• Merge

The code generator produces function code for Function-Call Subsystem, Simulink Function, Initialize
Function, and Reset Function blocks. For a Function-call Subsystem block, you connect the block
input ports to root Inport blocks that assert function-call signals. The subsystem is executed based on
the function-call signal that it receives. A Simulink Function block is executed in response to the
execution of a corresponding Function Caller block or Stateflow chart. An Initialize Function block is
executed on a model initialize event and a Reset Function block is executed on a user-defined reset
event.

For exporting functions, model rtwdemo_functions contains two function-call subsystems (f1_alg
and f2_alg) and a Simulink Function block (f3) for exporting functions. The model also contains an
Initialize Function block (Initialize Function) and a Reset Function block (Reset Function).
To calculate initial conditions for blocks with state in other parts of the model, State Writer blocks are
used inside the Initialize Function and Reset Function blocks.

open_system('rtwdemo_functions')

Create Model That Contains Function Caller Block

Use a Function Caller block to invoke a Simulink Function block. The Function Caller block can be in
the same model or in a different model as the Simulink Function block.

Multiple Function Caller blocks can invoke a Simulink Function block. You can place the Function
Caller block inside a function-call subsystem. During code generation, the code generator exports a
function from the function-call subsystem.

The model rtwdemo_caller exports a function-call subsystem that contains a Function Caller block.

open_system('rtwdemo_caller')

Create Test Harness Model for Simulation

When you export functions, the generated code does not include a scheduler. Create a test harness
model to handle scheduling during simulation. Do not use the test harness model to generate code
that you deploy.

Model rtwdemo_export_functions is a test harness. The model:
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• Schedules the Simulink Function block with the Function Caller block in rtwdemo_caller.
• Provides function-call signals to other models in this example to schedule the model contents,

including the model initialize and reset events.

open_system('rtwdemo_export_functions')

Simulate the Test Harness Model

Verify that the model containing the functions that you want to export is executed as you expect by
simulating the test harness model. For example, simulate rtwdemo_export_functions.

sim('rtwdemo_export_functions')

Generate Function Code

Open the Embedded Coder app. Then, generate code for the functions that you want to export. For
example, generate code for rtwdemo_functions.

slbuild('rtwdemo_functions')

### Starting build procedure for: rtwdemo_functions
### Successful completion of code generation for: rtwdemo_functions

Build Summary

Top model targets built:

Model              Action          Rebuild Reason                                    
=====================================================================================
rtwdemo_functions  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.737s

Review Generated Code

Review the generated code.

• ert_main.c is an example main program (execution framework) for the model. This code shows
how to call the exported functions. The code also shows how to initialize and execute the
generated code.

• rtwdemo_functions.c calls the initialization function, including Initialize Function, and
exported functions for model components f1_alg, f2_alg, and f3.

• rtwdemo_functions.h declares model data structures and a public interface to the exported
entry-point functions and data structures.

• f3.h is a shared file that declares the call interface for the Simulink function f3.
• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Write Interface Code

Open and review the Code Interface Report. To write the interface code for your execution
framework, use the information in that report.

1 Include the generated header files by adding directives #include rtwdemo_functions.h,
#include f3.h, and #include rtwtypes.h.
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2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:

• rtU.U1 of type real_T with dimension 1
• rtU.U2 of type real_T with dimension 1

Entry-point functions:

• Initialize entry-point function, void rtwdemo_functions_initialize(void). At startup, call
this function once.

• Reset entry-point function, void rtwdemo_functions_reset(void). Call this function as
needed.

• Exported function, void f1(void). Call this function as needed.
• Exported function, void f2(void). Call this function as needed.
• Simulink function, void f3(real_T rtu_u, real_T *rty_y). Call this function as needed.

Output ports:

• rtY.Accumulator1 of type int8_T with dimension [2]
• rtY.Accumulator2 of type int8_T with dimension [2]
• rtY.TicToc10 of type int8_T with dimension 1

More About

• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
• “Configure C Code Generation for Model Entry-Point Functions” on page 33-112
• “Generate Code for a Simulink Function and Function Caller”

Close Example Models

bdclose('rtwdemo_export_functions')
bdclose('rtwdemo_functions')
bdclose('rtwdemo_caller')

Generate C++ Function and Class Code for Export-Function Model
This example shows how to generate function code for an export-function model that includes a
function-call subsystem. The code generator produces function and class code that does not include
scheduling code.

To generate function code for export:

1 Create a model that contains the functions for export.
2 Create a test harness model that schedules execution of the functions during simulation.
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3 Simulate the model that contains the functions by using the test harness model.
4 Generate code for the model that contains the functions.

Create Model That Contains Functions and C++ Class Interface for Export

The model with functions for export with a C++ model class interface must satisfy architectural
constraints at the model root level. For C++ class generation, blocks that are valid at the root level
are:

• Inport
• Outport
• Function-Call Subsystem
• Goto
• From
• Merge

Note: Export Function-Call Subsystem with C++ class interface does not support Simulink Function
blocks.

The code generator produces function code for the Function-Call Subsystem block. For a Function-
call Subsystem block, you connect the block input ports to root Inport blocks that assert function-call
signals. The subsystem is executed based on the function-call signal that it receives.

Model rtwdemo_cppclass_functions contains function-call subsystems f1, f2, and f3 for
exporting functions.

open_system('rtwdemo_cppclass_functions')
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Create Test Harness Model for Simulation

When you export functions, the generated code does not include a scheduler. Create a test harness
model to handle scheduling during simulation. Do not use the test harness model to generate code
that you deploy.

Model rtwdemo_cppclass_export_functions is a test harness. The model provides function-call
signals to other models in this example to schedule the model contents.

open_system('rtwdemo_cppclass_export_functions')
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Simulate the Test Harness Model

Verify that the model containing the functions that you want to export is executed as you expect by
simulating the test harness model. For example, simulate rtwdemo_cppclass_export_functions.

sim('rtwdemo_cppclass_export_functions')

Generate Function Code and Report

Generate code and a code generation report for the functions that you want to export. For example,
generate code for rtwdemo_cppclass_functions.

slbuild('rtwdemo_cppclass_functions')

### Starting build procedure for: rtwdemo_cppclass_functions
### Successful completion of build procedure for: rtwdemo_cppclass_functions

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
rtwdemo_cppclass_functions  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.988s

Review Generated Code

From the code generation report, review the generated code.
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• ert_main.cpp is an example main program (execution framework) for the model. This code
shows how to call the exported functions. The code also shows how to initialize and execute the
generated code.

• rtwdemo_cppclass_functions.cpp calls the initialization function, including Initialize
Function, and exported functions for model subsystem components f1, f2, and f3.

• rtwdemo_cppclass_functions.h declares model data structures and a public interface to the
exported entry-point functions and data structures.

• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Write Interface Code

Open and review the Code Interface Report. To write the interface code for your execution
framework, use the information in that report.

1 Include the generated header files by adding directives #include
rtwdemo_cppclass_functions.h and #include rtwtypes.h.

2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:

• rtU.U1 of type real_T with dimension 1
• rtU.U2 of type real_T with dimension 1
• rtU.U3 of type real_T with dimension 1

Entry-point functions:

• Initialize entry-point function, void initialize(void). At startup, call this function once.
• Exported function, void t_1tic_A(void). Call this function as needed.
• Exported function, void t_1tic_B(void). Call this function as needed.
• Exported function, void t_1tic_C(void). Call this function as needed.

Output ports:

• rtY.TicToc1 of type int8_T with dimension [2]
• rtY.TicToc2 of type int8_T with dimension [2]
• rtY.TicToc10 of type int8_T with dimension 1

More About

• “Generate Component Source Code for Export to External Code Base” on page 56-47
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Customize Code Organization and Format” on page 53-42
• “Generate Code for a Simulink Function and Function Caller”
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Close Example Models

bdclose('rtwdemo_cppclass_export_functions')
bdclose('rtwdemo_cppclass_functions')

Generate Code for Export-Function Subsystems
• “Specify a Custom Initialize Function Name” on page 56-59
• “Specify a Custom Description” on page 56-60
• “Optimize Code Generated for Export-Function Subsystems” on page 56-60

To generate code for an export-function subsystem:

1 Verify that the subsystem for which you are generating code satisfies exporting requirements on
page 56-47.

2 In the Configuration Parameters dialog box:

a Set the parameter System target file to an ERT-based system target file, such as ert.tlc.
b If you want a SIL block with the generated code, for verification purposes, set model

configuration parameter Create block to SIL.
c Click OK or Apply.

3 Right-click the subsystem block and select C/C++ Code > Export Functions from the context
menu.

The operation creates a new model, subsystem.slx, that contains the content of the original
subsystem and creates a ScratchModel that contains a Model block. This block references the
newly created subsystem.slx model.

The Build code for subsystem: Subsystem dialog box opens. This dialog box is not specific to
export-function subsystems. Generating code does not require entering information in the dialog
box.

4 Click Build to build the newly created subsystem.slx model.

The code generator produces code and places it in the working folder.

If you set Create block to SIL in step 2b, Simulink opens a new window that contains an S-
function block that represents the generated code. This block has the same size, shape, and
connectors as the original subsystem.

Code generation and optional block creation are now complete. You can test and use the code and
optional block as you do for generated ERT code and S-function block. For optional workflow tasks,
see “Specify a Custom Initialize Function Name” on page 56-59 and “Specify a Custom Description”
on page 56-60.

Specify a Custom Initialize Function Name

You can specify a custom name for the initialize function of your exported function as an argument to
the slbuild command. The command takes the following form:
blockHandle = slbuild('subsystem', 'Mode', 'ExportFunctionCalls',..
             'ExportFunctionInitializeFunctionName', 'fcnname')
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fcnname specifies the function name. For example, if you specify the name 'myinitfcn', the build
process emits code similar to:

/* Model initialize function */
void myinitfcn(void){
...
}

Specify a Custom Description

You can enter a custom description for an exported function by using the Block Properties dialog box
of an Inport block.

1 Right-click the Inport block that drives the control port of the subsystem for which you are
exporting code.

2 Select Properties.
3 In the General tab, in the Description field, enter your descriptive text.

During function export, the text you enter is emitted to the generated code in the header for the
Inport block. For example, if you open the example program rtwdemo_exporting_functions and
enter a description in the Block Properties dialog box for port t_1tic_A, the code generator
produces code that is similar to:

/*
 * Output and update for exported function: t_1tic_A
 *
 *  My custom description of the exported function
*/
void t_1tic_A(void)
{
...
}

Optimize Code Generated for Export-Function Subsystems

To optimize the code generated for an export-function subsystem, specify a separate storage class for
each input signal and output signal that crosses the boundary of the subsystem.

For each function-call subsystem that you are exporting:

1 Right-click the subsystem.
2 From the context menu, choose Block Parameters (Subsystem).
3 Select the Code Generation tab.
4 Set Function packaging to Auto.
5 Click OK or Apply.

See Also

More About
• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “Using Triggered Subsystems”
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• “Using Function-Call Subsystems”
• “Export-Function Models Overview”
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Generate Shared Library for Export to External Code Base
In this section...
“About Generated Shared Libraries” on page 56-62
“Workflow” on page 56-62
“Generate Shared Libraries” on page 56-63
“Create Application Code That Uses Generated Shared Libraries” on page 56-63
“Limitations” on page 56-66

About Generated Shared Libraries
If you have Embedded Coder software, you can generate a shared library—Windows dynamic link
library (.dll), UNIX shared object (.so), or Macintosh OS X dynamic library (.dylib)— from a
model component. You or others can integrate the shared library into an application that runs on a
Windows, UNIX, or Macintosh OS X development computer. Uses of shared libraries include:

• Adding a software component to an application for system simulation
• Reusing software modules among applications on a development computer
• Hiding intellectual property associated with software that you share with vendors

When producing a shared library, the code generator exports:

• Variables and signals of type ExportedGlobal as data
• Real-time model structure (model_M) as data
• Functions essential to executing the model code

Workflow
To generate a shared library from a model component and use the library, complete the tasks listed in
this table.

Task Action More Information
1 Review your assessment of external code

characteristics and integration
requirements.

• “Choose an External Code Integration
Workflow” on page 56-3

• “Shared Library Limitations” on page 64-6
2 Configure the model for code generation. “Generate Code That Matches Appearance of

External Code” on page 56-80 and “Model
Configuration”

3 Configure the model for the code
generator to produce a shared library
and initiate code generation.

“Generate Shared Libraries” on page 56-63
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Task Action More Information
4 Verify that the generated shared library

meets requirements. For example, review
the code generation report and view the
list of symbols in the library.

• On Windows, use the Dependency
Walker utility, downloadable from
www.dependencywalker.com

• On UNIX, use nm -D model.so
• On Macintosh OS X, use nm -g

model.dylib

 

5 Use the shared library in application
code.

“Create Application Code That Uses Generated
Shared Libraries” on page 56-63

6 Compile and link application code that
loads and uses the generated shared
library.

“Build Integrated Code Within the Simulink
Environment” on page 56-40

7 Verify that executable program behaves
and performs as expected.

Generate Shared Libraries
1 When configuring the model for code generation, select the system target file ert_shrlib.tlc.
2 Build the model. The code generator produces source code for the model and a shared library

version of the code. The code generator places the source code in the code generation folder and
the shared library (.dll, .so, or .dylib file) in your current working folder. The code generator
also produces and retains a .lib file to support implicit linking.

Create Application Code That Uses Generated Shared Libraries
This example application code is generated for the example “Interface to a Development Computer
Simulator By Using a Shared Library” on page 56-67.

1 Create an application header file that contains type declarations for model external input and
output. For example:

#ifndef _APP_MAIN_HEADER_
#define _APP_MAIN_HEADER_

typedef struct {
    int32_T Input;
} ExternalInputs_rtwdemo_shrlib;

typedef struct {
    int32_T Output;
} ExternalOutputs_rtwdemo_shrlib;

#endif /*_APP_MAIN_HEADER_*/
2 In the application C source code, dynamically load the shared library. Use preprocessing

conditional statements to invoke platform-specific commands. For example:
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#if (defined(_WIN32)||defined(_WIN64)) /* WINDOWS */
#include <windows.h> 
#define GETSYMBOLADDR GetProcAddress 
#define LOADLIB LoadLibrary 
#define CLOSELIB FreeLibrary 

#else /* UNIX */ 
#include <dlfcn.h> 
#define GETSYMBOLADDR dlsym 
#define LOADLIB dlopen 
#define CLOSELIB dlclose 

#endif  

int main() 
{     
    void* handleLib;
... 
#if defined(_WIN64)
    handleLib = LOADLIB("./rtwdemo_shrlib_win64.dll");
#else #if defined(_WIN32) 
    handleLib = LOADLIB("./rtwdemo_shrlib_win32.dll");
#else /* UNIX */     
    handleLib = LOADLIB("./rtwdemo_shrlib.so", RTLD_LAZY); 
#endif 
#endif 
...     
    return(CLOSELIB(handleLib)); 
}

3 From the application C source code, access exported data and functions generated from the
model. The code uses hooks to add user-defined initialization, step, and termination code.

   int32_T i;
 ...
    void (*mdl_initialize)(boolean_T);
    void (*mdl_step)(void);
    void (*mdl_terminate)(void);

    ExternalInputs_rtwdemo_shrlib (*mdl_Uptr);
    ExternalOutputs_rtwdemo_shrlib (*mdl_Yptr);
        
    uint8_T (*sum_outptr);
...
#if (defined(LCCDLL)||defined(BORLANDCDLL))
    /* Exported symbols contain leading underscores 
       when DLL is linked with LCC or BORLANDC */
    mdl_initialize =
        (void(*)(boolean_T))GETSYMBOLADDR(handleLib ,
        "_rtwdemo_shrlib_initialize");
    mdl_step =
        (void(*)(void))GETSYMBOLADDR(handleLib ,
        "_rtwdemo_shrlib_step");
    mdl_terminate =
        (void(*)(void))GETSYMBOLADDR(handleLib ,
        "_rtwdemo_shrlib_terminate");
    mdl_Uptr =
        (ExternalInputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
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        "_rtwdemo_shrlib_U");
    mdl_Yptr =
        (ExternalOutputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
        "_rtwdemo_shrlib_Y");
    sum_outptr =
        (uint8_T*)GETSYMBOLADDR(handleLib , "_sum_out");
#else   
    mdl_initialize =
        (void(*)(boolean_T))GETSYMBOLADDR(handleLib ,
        "rtwdemo_shrlib_initialize");
    mdl_step =
        (void(*)(void))GETSYMBOLADDR(handleLib ,
        "rtwdemo_shrlib_step");
    mdl_terminate  =
        (void(*)(void))GETSYMBOLADDR(handleLib ,
        "rtwdemo_shrlib_terminate");
    mdl_Uptr =
        (ExternalInputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
        "rtwdemo_shrlib_U");
    mdl_Yptr =
        (ExternalOutputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
        "rtwdemo_shrlib_Y");
    sum_outptr =
        (uint8_T*)GETSYMBOLADDR(handleLib , "sum_out");
#endif
    
    if ((mdl_initialize && 
         mdl_step && 
         mdl_terminate && 
         mdl_Uptr && 
         mdl_Yptr && 
         sum_outptr)) {
        /* user application 
           initialization function */
        mdl_initialize(1); 
        /* insert other user defined 
           application initialization code here */
        
        /* user application 
           step function */
        for(i=0;i<=12;i++){ 
            mdl_Uptr->Input = i;
            mdl_step(); 
            printf("Counter out(sum_out): 
                   %d\tAmplifier in(Input): 
                   %d\tout(Output): 
                   %d\n", *sum_outptr, i, 
                   mdl_Yptr->Output); 
            /* insert other user defined 
               application step function 
               code here */
        }
        
        /* user application 
           terminate function */
        mdl_terminate();
        /* insert other user defined 
           application termination 
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           code here */
    }
    else {
        printf("Cannot locate the specified 
                reference(s) in the shared library.\n");
        return(-1);
    }

Limitations
• Code generation for the ert_shrlib.tlc system target file exports the following as data:

• Variables and signals of type ExportedGlobal
• Real-time model structure (model_M)

• Code generation for the ert_shrlib.tlc system target file supports the C language only (not C
++). When you select ert_shrlib.tlc, language selection is unavailable on the Code
Generation pane in the Configuration Parameters dialog box.

• To reconstruct a model simulation by using a generated shared library, the application author
must maintain the timing between system and shared library function calls in the original
application. The timing must be consistent so that you can compare the simulation and integration
results. Additional simulation considerations apply if generating a shared library from a model
that enables model configuration parameters Support: continuous time and Single output/
update function. For more information, see Single output/update function (Simulink Coder)
dependencies.

See Also

More About
• “Interface to a Development Computer Simulator By Using a Shared Library” on page 56-67
• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “Configure a System Target File” on page 48-2
• “Manage Build Process Files” on page 50-34
• “Model Protection”
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Interface to a Development Computer Simulator By Using a
Shared Library

This example generates a shared library for interfacing to a simulator that runs on your development
computer. Generate the shared library by using the system target file ert_shrlib.tlc.

To build a shared library from the model and use the library in an application:

1. Develop your model. For this example, open the model rtwdemo_shrlib. Save a copy of the
model to a writable location.

open_system('rtwdemo_shrlib');

The model is a single-rate, discrete-time model. An 8-bit counter feeds the triggered subsystem
named Amplifier. Parameters INC, LIMIT, and RESET are set to constant values 1, 4, and 0,
respectively. When signal equal_to_count is true, the subsystem amplifies its input signal by a gain
factor K=3 and the output signal is updated.

2. Open the Embedded Coder app.

3. Set model configuration parameter System target file to ert_shrlib.tlc.
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4. Build the shared library file. The file that the code generator produces depends on your
development platform. For example, on a Windows system, the code generator produces the library
file rtwdemo_shrlib_win64.dll.

5. Create application code that uses the shared library. This example uses application code that is
available in these files:

matlabroot\toolbox\rtw\rtwdemos\shrlib_demo\rtwdemo_shrlib_app.h matlabroot
\toolbox\rtw\rtwdemos\shrlib_demo\rtwdemo_shrlib_app.c

To view the source code in these files, in the model, click the white buttons for the .h and .c files.

6. Compile and link the file application and shared library files to produce an executable program.
The following script compiles, builds, and runs the program.

matlabroot\toolbox\rtw\rtwdemos\shrlib_demo\run_rtwdemo_shrlib_app.m

To view the script code, in the model, click the white button for the .m file.

To build the model and run the application that uses the generated shared library, in the model,
double-click the blue button.

For more information about using a shared library, see “Package Generated Code as Shared
Libraries” on page 64-2.

See Also

More About
• “Generate Shared Library for Export to External Code Base” on page 56-62
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Exchange Data Between External C/C++ Code and Simulink
Model or Generated Code

Whether you import your external code into a Simulink model (for example, by using the Legacy Code
Tool) or export the generated code to an external environment, the model or the generated code
typically exchange data (signals, states, and parameters) with your code.

Functions in C or C++ code, including your external functions, can exchange data with a caller or a
called function through:

• Arguments (formal parameters) of functions. When a function exchanges data through arguments,
an application can call the function multiple times. Each instance of the called function can
manipulate its own independent set of data so that the instances do not interfere with each other.

• Direct access to global variables. Global variables can:

• Enable different algorithms (functions) and instances of the same algorithm to share data such
as calibration parameters and error status.

• Enable the different rates (functions) of a multitasking system to exchange data.
• Enable different algorithms to exchange data asynchronously.

In Simulink, you can organize and configure data so that a model uses these exchange mechanisms to
provide, extract, and share data with your code.

Before you attempt to match data interfaces, to choose an overall integration approach, see “Choose
an External Code Integration Workflow” on page 56-3.

Import External Code into Model
To exchange data between your model and your external function, choose an exchange mechanism
based on the technique that you chose to integrate the function.

• To exchange data through the arguments of your external function, construct and configure your
model to create and package the data according to the data types of the arguments. Then, you
connect and configure the block that calls or represents your function to accept, produce, or refer
to the data from the model.

For example, if you use the Legacy Code Tool to generate an S-Function block that calls your
function, the ports and parameters of the block correspond to the arguments of the function. You
connect the output signals of upstream blocks to the input ports and set parameter values in the
block mask. Then, you can create signal lines from the output ports of the block and connect those
signals to downstream blocks.

• To exchange data through global variables that your external code already defines, a best practice
is to use a Stateflow chart to call your function and to access the variables. You write algorithmic
C code in the chart so that during simulation or execution of the generated code, the model reads
and writes to the variables.

To use such a global variable as an item of parameter data (not signal or state data) elsewhere in a
model, you can create a numeric MATLAB variable or Simulink.Parameter object that
represents the variable. If you change the value of the C-code variable in between simulation runs,
you must manually synchronize the value of the Simulink variable or object. If your algorithmic
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code (function) changes the value of the C-code variable during simulation, the corresponding
Simulink variable or object does not change.

If you choose to create a Simulink representation of the C-code variable, you can configure the
Simulink representation so that the generated code reads and writes to the variable but does not
duplicate the variable definition. Apply a storage class to the Simulink representation.

Technique for
Integrating
External Function

Mechanism to
Exchange Data with
Model

Examples and More Information

S-Function block Function arguments To call your function through an S-function that you create by
using the Legacy Code Tool, see “Integrate C Functions into
Simulink Models with Legacy Code Tool”.

Stateflow chart Function arguments and
direct access to global
variables

To call your function and access global variables in a
Stateflow chart, see “Access Custom Code Variables and
Functions in Stateflow Charts” (Stateflow). For information
about creating data items in a chart (which you can pass to
your function as arguments), see “Add Stateflow Data”
(Stateflow).

coder.ceval in
MATLAB Function
block

Function arguments To call your function in a MATLAB Function block by using
coder.ceval, see “Integrate C Code Using the MATLAB
Function Block”. For information about creating data items in
a MATLAB Function block (which you can pass to your
function as arguments), see “Ports and Data Manager”.

Export Generated Code to External Environment
To export the generated code into your external code, see “Exchange Data Between External Calling
Code and Generated Code”.

Simulink Representations of C Data Types and Constructs
To model and reuse your custom C data such as structures, enumerations, and typedef aliases, use
the information in these tables.
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Modeling Patterns for Matching Data in External C Code

C Data Type
or Construct

Example C Code Simulink Equivalent More Information

Primitive type
alias
(typedef)

typedef float mySinglePrec_T; Create a
Simulink.AliasType
object. Use the object to:

• Set the data types of
signals and block
parameters in a model.

• Configure data type
replacements for code
generation.

Generating code that uses an
alias data type requires
Embedded Coder.

For information about
defining custom data
types for your model,
see
Simulink.AliasType
and “Control Data Type
Names in Generated
Code” on page 36-2.

For an example that
shows how to export the
generated code into
your external code, see
“Replace and Rename
Data Types to Conform
to Coding Standards” on
page 36-22.

Array int myArray[6]; Specify signal and parameter
dimensions as described in
“Determine Signal
Dimensions”.

The generated code defines
and accesses
multidimensional data,
including matrices, as
column-major serialized
vectors. If your external code
uses a different format,
consider using alternative
techniques to integrate the
generated code. See “Code
Generation of Matrices and
Arrays” on page 50-60.

For information about
how the generated code
stores nonscalar data
(including limitations),
see “Code Generation of
Matrices and Arrays”.

For an example that
shows how to export the
generated code into
your external code, see
“Reuse Parameter Data
from External Code in
the Generated Code” on
page 38-2.

To model lookup tables,
see
Simulink.LookupTab
le.
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C Data Type
or Construct

Example C Code Simulink Equivalent More Information

Enumeration typedef enum myColorsType {
  Red = 0,
  Yellow,
  Blue
} myColorsType;

Define a Simulink
enumeration that corresponds
to your enumeration
definition. Use the Simulink
enumeration to set data types
in a model.

To use enumerated data
in a Simulink model, see
“Use Enumerated Data
in Simulink Models”.

For an example that
shows how to generate
enumerated parameter
data, see “Enumeration”
on page 25-20.

For an example that
shows how to export the
generated code into
your external code by
exchanging enumerated
data, see “Exchange
Structured and
Enumerated Data
Between Generated and
External Code” on page
36-27.
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C Data Type
or Construct

Example C Code Simulink Equivalent More Information

Structure typedef struct myStructType {
    int count;
    double coeff;
} myStructType;

Create a Simulink.Bus
object that corresponds to
your structure type.

To create structured signal or
state data, package multiple
signal lines in a model into a
single nonvirtual bus signal.

To create structured
parameter data, create a
parameter object (such as
Simulink.Parameter) that
stores a MATLAB structure.
Use the bus object as the data
type of the parameter object.

To package lookup table data
into a structure, use
Simulink.LookupTable
and, optionally,
Simulink.Breakpoint
objects.

For information about
bus signals, see “Group
Signal Lines into Virtual
Buses”. For information
about structures of
parameters, see
“Organize Related Block
Parameter Definitions in
Structures”.

For an example that
shows how to import
your external code into
a model by using the
Legacy Code Tool, see
“Integrate C Function
Whose Arguments Are
Pointers to Structures”.

For examples that show
how to export the
generated code into
your external code, see
“Exchange Structured
and Enumerated Data
Between Generated and
External Code” on page
36-27 and “Access
Structured Data
Through a Pointer That
External Code Defines”
on page 38-10.

To package lookup table
data into a structure,
Simulink.LookupTab
le.

For general information
about creating
structures in the
generated code, see
“Organize Data into
Structures in Generated
Code”.
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Additional Modeling Patterns for Code Generation (Embedded Coder)

C Data Type
or Construct

Example C Code Simulink Equivalent More Information

Macro #define myParam 9.8 Apply the storage classes
Define and
ImportedDefine to
parameters. With macros,
you can reuse a
parameter value in
multiple locations in an
algorithm and change the
parameter value between
code compilations
without consuming
memory to store the
value. Typically, macros
represent engineering
constants that you do not
expect to change during
code execution.

This technique requires
Embedded Coder.

“Macro Definitions
(#define)” on page 25-54

Storage type
qualifiers such
as const and
volatile

const myParam = 9.8; Apply the storage classes
Const, Volatile, and
ConstVolatile to data
items.

“Protect Global Data with
Keywords const and
volatile”

Bit field typedef struct myBitField {
    unsigned short int MODE : 1;
    unsigned short int FAIL : 1;
    unsigned short int OK : 1;
} myBitField

• Apply the storage
class BitField to
signals, states, and
parameters whose
data type is boolean.

• Use a model
configuration
parameter to
aggregate Boolean
data into bit fields.

These techniques require
Embedded Coder.

“Bitfields” on page 25-68

“Optimize Generated
Code By Packing Boolean
Data Into Bitfields” on
page 73-11

56 External Code Integration in Simulink Coder

56-74



C Data Type
or Construct

Example C Code Simulink Equivalent More Information

Call to custom
external
function that
reads or writes
to data

External code:

/* Call this function
to acquire the value of
the signal. */
double get_inSig(void)
{
    return myBigGlobalStruct.inSig;
}

Generated algorithmic code:

algorithmInput = get_inSig();

Apply the storage class
GetSet to signals, states,
and parameters. Each
data item appears in the
generated code as a call
to your custom functions
that read and write to the
target data.

This technique requires
Embedded Coder.

“Access Data Through
Functions with Storage
Class GetSet” on page
38-26

Considerations for Other Modeling Goals

Goal Considerations and More Information
Use Simulink to run and
interact with the generated
code

You can use SIL, PIL, and external mode simulations to connect your model to the
corresponding generated application for simulation. When you import parameter
data from your external code:

• At the time that you begin an external mode simulation, the external
executable uses the value that your code uses to initialize the parameter data.
However, when you change the corresponding value in Simulink during the
simulation (for example by modifying the Value property of the corresponding
parameter object), Simulink downloads the new value to the executable.

• SIL and PIL simulations do not import the parameter value from your code.
Instead, the simulations use the parameter value from Simulink. If you include
your external code in the Simulink Coder build process, duplicate data
definitions can prevent the generated code from compiling.

For information about SIL and PIL, see “Choose a SIL or PIL Approach” on page
80-11. For information about external mode simulation, see “External Mode
Simulations for Parameter Tuning and Signal Monitoring”.

Generate code comments
that describe attributes of
exported data including
physical units, real-world
initial value, and data type

Generating these comments can help you match data interfaces while
handwriting integration code. See “Add Custom Comments for Variables in the
Generated Code” on page 53-3.

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
• “Generate Code That Matches Appearance of External Code” on page 56-80
• “Design Data Interface by Configuring Inport and Outport Blocks” on page 34-167
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• “Configure Generated Code According to Interface Control Document Specifications” on page
38-55

• “Generate Code That Dereferences Data from a Literal Memory Address” on page 66-16
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Exchange Data Between External Calling Code and Generated
Code

To export the generated code into your external code, you configure the generated code to match the
data interface of your external code. For example, if your external code defines a global variable for
storing output data and you need the generated code to read that data as input, you can configure a
corresponding Inport block so that the generated code interacts with the existing variable.

• You can generate reentrant code from a model. The generated entry-point functions typically
accept data through arguments. Your calling code passes data through these arguments. You can
call the functions multiple times in a single application—the application can maintain multiple
instances of the model. See “Data Exchange for Reentrant Generated Code”.

• When you generate nonreentrant code, by default, the entry-point functions exchange data
between the generated code and your code through global variables. You can generate variable
definitions for your code to use or you can share and reuse existing variables that your code
already defines. See “Data Exchange for Nonreentrant Generated Code”.

Alternatively, you can configure the entry-point functions to exchange system inputs and outputs
(root-level Inport and Outport blocks) through arguments instead of global variables. Apply
function prototype control to the model, which requires Embedded Coder. For more information
about function prototype control, see “Configure C Code Generation for Model Entry-Point
Functions” on page 33-112.

For general information about exchanging data between generated and external code, including how
to match specific C code patterns, see “Exchange Data Between External C/C++ Code and Simulink
Model or Generated Code”.

Data Exchange for Reentrant Generated Code
When you generate reentrant code, the model entry-point functions exchange data through
arguments. You can control some of the characteristics of the arguments. For more information, see
“Control Data and Function Interface in Generated Code”.

For information about creating a separate set of data for each call site in your external code, see
“Modify Static Main to Allocate and Access Model Instance Data” on page 66-11.

Data Exchange for Nonreentrant Generated Code
To make the generated code read or write to an item of signal, state, or parameter data as a global
variable, apply a storage class to the data in the model. The storage class also determines whether
the generated code exports the variable definition to your external code or imports the definition
from your code. For general information about controlling the data interface of a model that you
configure to generate nonreentrant code, see “Control Data Interface for Nonreentrant Code”. For
examples, see “Design Data Interface by Configuring Inport and Outport Blocks” and “Integrate
External Application Code with Code Generated from PID Controller” on page 38-46.

When you generate code that defines (allocates memory for) global data, the generated code exports
that data. When your external code defines data, the generated code imports that data. Typically,
storage classes that import data have the word Import in the storage class name, for example,
ImportedExternPointer.
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Control File Placement of Exported Global Data (Embedded Coder)

When you export data from the generated code by using storage classes, the code generator creates
an extern declaration. By default, this declaration typically appears in the generated header file
model.h. You can include (#include) this header file in your external code.

By default, the definition (memory allocation) of exported data typically appears in model.c.

You can control the file placement of the declarations and definitions to:

• Create separate object files that store only global parameter data.
• Modularize the generated code by organizing declarations into separate files.

For more information about controlling file placement of declarations and definitions, see “Control
Placement of Global Data Definitions and Declarations in Generated Files” on page 35-2. For an
example, see “Definition, Initialization, and Declaration of Parameter Data” on page 25-5.

Prevent Duplicate Initialization Code for Global Variables

When your external code defines global variables, you can generate code that interacts with those
variables. For example, use the storage class ImportFromFile (see “Choose Storage Class for
Controlling Data Representation in Generated Code”).

For imported variables that represent signal or state data, the code generator can produce
initialization code as described in “Initialization of Signal, State, and Parameter Data in the
Generated Code”. If your code already initializes a variable, consider preventing the generation of
duplicate initialization code. Create your own storage class and, for that storage class, set Data
initialization to None. For information about creating and applying your own storage class, see
“Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” on
page 31-2.

Protect Global Data with Keywords const and volatile

When your external code and the generated code exchange data through global variables, you can
generate code that uses C type qualifiers const and volatile to protect data integrity and improve
the safety of your application. For example:

• Apply const to a calibration parameter.
• Apply volatile to a global variable that stores the output of a hardware device operating

asynchronously.
• Apply const and volatile to signals, states, and parameters that represent data defined by your

external code. Then, the generated code declares and interacts with the external data by using the
corresponding storage type qualifiers.

You must have Embedded Coder. For more information, see “Protect Global Data with const and
volatile Type Qualifiers” on page 43-13.

See Also

Related Examples
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code”
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• “Control Data and Function Interface in Generated Code”
• “Design Data Interface by Configuring Inport and Outport Blocks”
• “Integrate External Application Code with Code Generated from PID Controller” on page 38-46
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Generate Code That Matches Appearance of External Code
A key aspect of code integration, especially for larger projects, is adherence to guidelines and
standards for code appearance. If code appearance requirements apply to your project, review the
requirements in this table. To learn more, see the relevant information.

Requirement More Information
Thoroughly document code or document code in
a specific way.

• “Configure Code Comments” on page 46-22
• “Annotate Code for Justifying Polyspace Checks” on page

53-82
• “Add Custom Comments for Variables in the Generated

Code” on page 53-3
• “Add Global Comments in the Generated Code” on page

53-5
Control the length and naming of code identifiers
(symbols), including the use of reserved names.

• “Identifier Format Control” on page 53-15
• “Specify Identifier Length to Avoid Naming Collisions” on

page 46-29
• “Specify Reserved Names for Generated Identifiers” on

page 46-30
• “Customize Generated Identifier Naming Rules” on page

53-10
• “Avoid Identifier Name Collisions with Referenced

Models” on page 53-22
• “Control Name Mangling in Generated Identifiers” on

page 53-21
• “Specify Boolean and Data Type Limit Identifiers” on

page 36-34
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Requirement More Information
Control style aspects of code:

• Level of parenthesization
• Order of operations in expressions
• Empty primary condition expressions in if

statements
• if-elseif-else or switch-case

statements for decision logic
• Use of extern keyword in function

declarations
• Use of static keyword in function

declarations
• Use of default cases for switch-case

statements
• Use multiplications by powers of two or

signed bitwise shifts
• Cast expressions
• Indent style (Kernighan and Ritchie or

Allman) and size
• Newline style

“Model Configuration Parameters: Code Style”

Placement of data definitions and declarations,
including location of global identifiers and global
data declarations (extern)

“Control Placement of Global Data Definitions and
Declarations in Generated Files” on page 35-2

Appearance of code for flow charts “Enhance Readability of Code for Flow Charts” on page 53-
91

Apply code templates to control organization of
code and use of banners

• “Customize Code Organization and Format” on page 53-
42

• “Template Symbols and Rules” on page 53-77
• “Specify Templates For Code Generation” on page 53-44
• “Generate Custom File and Function Banners” on page

53-70
• “Change the Organization of a Generated File” on page

53-54
• “Generate Source and Header Files with a Custom File

Processing (CFP) Template” on page 53-58
• “Customize Generated File Names” on page 53-56

See Also

More About
• “Code Appearance”
• “Choose an External Code Integration Workflow” on page 56-3
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Program Building, Interaction, and
Debugging in Simulink Coder

• “Select C or C++ Programming Language” on page 57-2
• “Select and Configure C or C++ Compiler” on page 57-3
• “Troubleshoot Compiler Issues” on page 57-7
• “Choose Build Approach and Configure Build Process” on page 57-11
• “Template Makefiles and Make Options” on page 57-21
• “Build Process Workflow for Real-Time Systems” on page 57-25
• “Build Models from a Windows Command Prompt Window” on page 57-31
• “Rebuild a Model” on page 57-33
• “Control Regeneration of Top Model Code” on page 57-34
• “Reduce Build Time for Referenced Models by Using Parallel Builds” on page 57-36
• “Relocate Code to Another Development Environment” on page 57-41
• “Compile and Debug Generated C Code with Microsoft® Visual Studio®” on page 57-46
• “Executable Program Generation” on page 57-47
• “Profile Code Execution Speed” on page 57-49
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Select C or C++ Programming Language
The default programming language selection for code generation is C language. In the code
generation workflow, after the steps in “Select a Solver That Supports Code Generation” and “Select
a System Target File from STF Browser”, an optional step is to change the programming language
selection for code generation.

To change the programming language setting:

1 In the Configuration Parameters dialog box, from the Language list, select C or C++.
Alternatively, set the TargetLang parameter at the command line.

The code generator produces .c or .cpp files, depending on your selection, and places the
generated files in your build folder.

For more information, see “Language”.
2 Check whether you must choose and configure a compiler. If you select C++, you must choose

and configure a compiler. For details, see “Select and Configure C or C++ Compiler”.
3 Check whether the standard math library is configured for your compiler. By default, the code

generator uses the ISO/IEC 9899:1999 C (C99 (ISO)) library for the C language and the
ISO/IEC 14882:2003 C++ (C++03 (ISO)) library for the C++ language.

For more information, see “Standard math library”.

See Also

More About
• “Select and Configure C or C++ Compiler”
• “Troubleshoot Compiler Issues”
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Select and Configure C or C++ Compiler
The build process requires a supported compiler. Compiler, in this context, refers to a development
environment containing a linker and make utility, and a high-level language compiler. For details on
supported compiler versions, see:

https://www.mathworks.com/support/compilers/current_release

When creating an executable program, the build process must be able to access a supported
compiler. The build process can find a compiler to use based on your default MEX compiler.

The build process also requires the selection of a toolchain or template makefile. The toolchain or
template makefile determines which compiler runs, during the make phase of the build. For more
information, see “Choose Build Approach and Configure Build Process”

To determine which templates makefiles are available for your compiler and system target file, see
“Compare System Target File Support Across Products”.

For both generated files and user-supplied files, the file extension, .c or .cpp, determines whether
the build process uses a C or a C++ compiler. If the file extension is .c, the build process uses C
compiler to compile the file, and the symbols use the C linkage convention. If the file extension
is .cpp, the build process uses a C++ compiler to compile the file, and the symbols use the C++
linkage specification.

Language Standards Compliance
The code generator produces code that is compliant with the following standards:

Language Supported Standard
C ISO/IEC 9899:1990, also known as C89/C90
C++ ISO/IEC 14882:2003

Code that the code generator produces from these sources is ANSI C/C++ compliant:

• Simulink built-in block algorithmic code
• Generated system-level code (task ID [TID] checks, management, functions, and so on)
• Code from other blocksets, including the Fixed-Point Designer product and the Communications

Toolbox product
• Code from other code generators, such as MATLAB functions

Also, the code generator can incorporate code from:

• Embedded system target files (for example, startup code, device driver blocks)
• Custom S-functions or TLC files

Note Coding standards for these two sources are beyond the control of the code generator. These
standards can be a source for compliance problems, such as code that uses C99 features not
supported in the ANSI C, C89/C90 subset.
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Programming Language Considerations
The code generator produces C and C++ code. Consider the following as you choose a programming
language:

• Does your project require you to configure the code generator to use a specific compiler? C/C++
code generation on Windows requires this selection.

• Does your project require you to change the default language configuration setting for the model?
See “Select C or C++ Programming Language” on page 57-2.

• Does your project require you to integrate legacy or custom code with generated code? For a
summary of integration options, see “What Is External Code Integration?” on page 56-2.

• Does your project require you to integrate C and C++ code? If so, see “What Is External Code
Integration?” on page 56-2.

Note You can mix C and C++ code when integrating generated code with custom code. However,
you must be aware of the differences between C and default C++ linkage conventions, and add
the extern "C"' linkage specifier where required. For the details of the differing linkage
conventions and how to apply extern "C", refer to a C++ programming language reference
book.

• Does your project require code generation support from other products? See “C++ Language
Support Limitations” on page 57-4.

For C++ code generation examples with Stateflow, see the sfcndemo_cppcount model or sf_cpp
model.

C++ Language Support Limitations
To use C++ language support, you could need to configure the code generator to use a specific
compiler. For example, if a supported compiler is not installed on your Microsoft Windows computer,
the default compiler is the lcc C compiler shipped with the MATLAB product. This compiler does not
support C++. If you do not configure the code generator to use a C++ compiler before you specify C
++ for code generation, the software produces an error message.

Code generator limitations on C++ support include:

• The code generator does not support C++ code generation for the following:
Simscape Driveline
Simscape Multibody First Generation (Simscape Multibody Second Generation is supported)
Simscape Electrical Power Systems
Simulink Real-Time

• For ERT and ERT-based system target files with Code interface packaging set to Nonreusable
function, the following fields currently do not support the .cpp extension.

• Data definition filename
• Definition file for a data object, which is an object of the Simulink.Signal or

Simulink.Parameter classes or their subclasses.

If you specify a file name with a .c extension or with no extension and specify C++ for the code
generation language, the code generator produces a .cpp file.
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Code Generator Assumes Wrap on Signed Integer Overflows
The code generator reduces memory usage and enhances generated code execution by assuming
signed integer C operations wrap on overflow. A signed integer overflow occurs when the result of an
arithmetic operation is outside the range of values that the output data type can represent. The C
programming language does not define the results of such operations. Some C compilers aggressively
optimize signed operations for in-range values at the expense of overflow conditions. Other compilers
preserve the full wrap-on-overflow behavior. For example, the gcc and MinGW compilers provide an
option to wrap on overflow reliably for signed integer overflows. The generated program image for a
model can produce results that differ from model simulation results because the handling of
overflows varies, depending on your compiler.

When you generate code, if you use a supported compiler with the default options configured by the
code generator, the compiler preserves the full wrap-on-overflow behavior. If you change the compiler
options or compile the code in another development environment, it is possible that the compiler does
not preserve the full wrap-on-overflow behavior. In this case, the executable program can produce
unpredictable results.

If this issue is a concern for your application, consider one or more of the following actions:

• Verify that the compiled code produces expected results.
• If your compiler can force wrapping behavior, turn it on. For example, for the gcc compiler or a

compiler based on gcc, such as MinGW, configure the build process to use the compiler option -
fwrapv.

• Choose a compiler that wraps on integer overflow.
• If you have Embedded Coder installed, develop and apply a custom code replacement library to

replace code generated for signed integers. For more information, see “Code Replacement
Customization”.

Choose and Configure Compiler
To view the installed compilers and select the default compiler, in the Command Window, type:

mex -setup

On a Windows computer, you can install supported compilers and select a default compiler.

On a UNIX platform, the default compiler is GNU gcc/g++ for GNU or Xcode for Mac.

Unless the build approach configuration selects a specific compiler, the code generator uses the
default compiler for the build process.

Primarily, the specified system target file determines the compiler that the code generator requires:

• If you select a toolchain-based system target file such as grt.tlc (Generic Real-Time Target),
ert.tlc (Embedded Coder), or autosar.tlc (Embedded Coder for AUTOSAR), the Build
process subpane displays configuration parameters for the build process. Use the Toolchain
configuration parameter to select a compiler and associated tools for your model build. To validate
the selected toolchain, click the Validate Toolchain.

• If you select a template makefile (TMF) based system target file, such as rsim.tlc, the Build
process subpane displays template makefile parameters for configuring the build process. The
Template makefile parameter displays the default TMF file for the selected system target file. If
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the system target file supports compiler-specific template makefiles (for example, Rapid
Simulation or S-Function system target files), you can set Template makefile to a compiler-
specific TMF, such as rsim_lcc.tmf or rsim_unix.tmf. (See “Compare System Target File
Support Across Products” for valid TMF names.)

If the generated code exceeds the 2 Gb static memory limit, a compiler error occurs. To resolve this
issue:

• For GRT-based system target files, set model configuration parameter Code interface packaging
to Reusable function.

• For ERT-based system target files, set model configuration parameter Code interface packaging
to Reusable function and select parameter Use dynamic memory allocation for model
initialization.

Include S-Function Source Code
When the code generator builds models with S-functions, source code for the S-functions can be
either in the current folder or in the same folder as their MEX-file. The code generator adds an
include path to the generated makefiles whenever it finds a file named sfncname.h in the same
folder as the S-function MEX-file. This folder must be on the MATLAB path.

Similarly, the code generator adds a rule for the folder when it finds a file sfncname.c (or .cpp) in
the same folder as the S-function MEX-file is in.

See Also

More About
• “Run-Time Environment Configuration”
• “Compare System Target File Support Across Products”
• “Select C or C++ Programming Language”
• “Troubleshoot Compiler Issues” on page 57-7

External Websites
• https://www.mathworks.com/support/compilers/current_release
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Troubleshoot Compiler Issues

In this section...
“Compiler Version Mismatch Errors” on page 57-7
“Results for Model Simulation and Program Execution Differ” on page 57-7
“Generates Expected Code and Produces Unexpected Results” on page 57-8
“Compile-Time Issues” on page 57-8
“LCC Compiler Does Not Support Ampersands in Source Folder Paths” on page 57-9
“LCC Compiler Might Not Support Line Lengths of Rapid Accelerator Code” on page 57-9

Compiler Version Mismatch Errors
Description

The build process produces a compiler version mismatch error.

Action

1 Check the list of supported and compatible compilers available at www.mathworks.com/
support/compilers/current_release/.

2 Upgrade or change your compiler. For more information, see “Choose and Configure Compiler”
on page 57-5.

3 Rebuild the model.

Results for Model Simulation and Program Execution Differ
Description

The program generated for the model produces different results from model simulation results. The
generated source code includes an arithmetic operation that produces a signed integer overflow. It is
possible that your compiler does not implement wrapping behavior for signed integer overflow
conditions. Or, if you are using a compiler that supports wrapping, it is possible that you did not
configure it to use the -fwrapv option.

For more information, see “Code Generator Relies on Undefined Behavior of C Language for Integer
Overflows.”

Action

• If your compiler can force wrapping behavior, turn it on. For example, for the gcc compiler or a
compiler based on gcc, such as MinGW, specify the compiler option -fwrapv.

• Choose a compiler that checks for integer overflows.
• If you have Embedded Coder, develop and apply a code replacement library to replace code

generated for signed integers.
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Generates Expected Code and Produces Unexpected Results
Description

The build process generates expected source code, but the executable program produces unexpected
results. The generated source code appears as expected. However, the executable program produces
unexpected results.

Action

Do one of the following:

• Lower the compiler optimization level.

1 Set the Compiler optimization level configuration parameter to Custom.
2 In the Custom compiler optimization flags field, specify a lower optimization level.
3 Rebuild the model.

• Disable compiler optimizations.

1 Set Compiler optimization level to Optimizations off (faster builds).
2 Rebuild the model.

For more information, see “Control Compiler Optimizations” and your compiler documentation.

Compile-Time Issues
Issue Action
Error is present in the compiler configuration. Make sure that MATLAB supports the compiler

and version that you want to use. For a list of
currently supported and compatible compilers,
see www.mathworks.com/support/
compilers/current_release/. If necessary,
upgrade or change your compiler (see “Choose
and Configure Compiler” on page 57-5 or
“Choose and Configure Compiler” on page 57-5).

Environment variables are incorrectly set up for
your make utility, compiler, or linker. For
example, installation of Cygwin tools on a
Windows platform affects environment variables
used by other compilers.

Review the environment variable settings for
your system by using the set command on a
Windows platform or setenv on a Linux
platform. Make sure that the settings match what
is required for the tools you are using.

Error is present in custom code specified as an S-
Function block or in Custom Code. For example,
the code refers to a header file that the compiler
cannot find.

To isolate the source of the problem, remove the
custom code from the model, debug, and rebuild
the model.

The model includes a block, such as a device
driver block, which is not intended for use with
the currently selected system target file.

Remove the system target file-specific block or
configure the model for use with another system
target file.
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Issue Action
A linker error about an undefined reference to
the data appears when the model build generates
an executable program from the model reference
hierarchy and these conditions are true:

• You represent signal, state, or parameter data
by creating a data object such as
Simulink.Signal. You use the object in a
model reference hierarchy.

• You use a custom storage class with the data
object. Custom storage classes require
Embedded Coder.

• You set the owner of the object to a model that
does not directly access the data.

• You use the toolchain lcc-win64.

To resolve the issue, choose one of these
methods:

• In the data object, clear the Owner property.
Alternatively, set the owner to a model that
directly accesses the data.

• Use a different toolchain, such as gcc, instead
of lcc.

LCC Compiler Does Not Support Ampersands in Source Folder Paths
Description

If you use the LCC compiler and your model folder path contains an ampersand (&), the build process
produces an error.

Action

Remove the ampersand from the model folder path. Then, rebuild the model.

LCC Compiler Might Not Support Line Lengths of Rapid Accelerator
Code
Description

If you are compiling Rapid Accelerator code, the LCC compiler might produce an error related to line
limits. Rapid Accelerator code can have longer line lengths due to obfuscation.

Action

Compile your Rapid Accelerator code using a compiler that supports longer code lines.

See Also

More About
• “Choose and Configure Compiler” on page 57-5
• “Select C or C++ Programming Language”
• “Troubleshoot Compiler Issues” on page 57-7
• “Choose Build Approach and Configure Build Process” on page 57-11
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• “Build Process Workflow for Real-Time Systems” on page 57-25
• “Rebuild a Model” on page 57-33
• “Reduce Build Time for Referenced Models by Using Parallel Builds” on page 57-36
• “Control Regeneration of Top Model Code” on page 57-34
• “Relocate Code to Another Development Environment” on page 57-41
• “Profile Code Execution Speed” on page 57-49
• “Control Compiler Optimizations”
• “Select and Configure C or C++ Compiler” on page 57-3
• “Executable Program Generation” on page 57-47

External Websites
• www.mathworks.com/support/compilers/current_release/
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Choose Build Approach and Configure Build Process
The code generator supports these approaches for building (compiling and linking) code that you
generate from Simulink models:

• Toolchain — A build process that generates makefiles and supports custom toolchains. This
approach:

• Provides control of your build process with toolchain information objects. You can define these
objects using MATLAB scripts.

• Supports model referencing, SIL, and PIL.
• Supports Simulink Coder, Embedded Coder, and MATLAB Coder.

• Template makefile — A build process that uses a template makefile with a toolchain that you
specify. This approach:

• Optionally uses a toolchain information object.
• Supports model referencing, SIL, and PIL.
• Supports Simulink Coder and Embedded Coder.

You can use the “System target file” configuration parameter to select the build process for a model.
When you set the System target file to:

• ert.tlc, ert_shrlib.tlc, grt.tlc, or any toolchain-compliant system target file, the build
process uses the toolchain approach on page 57-11 by default.

• Any non-toolchain-compliant system target file, the build process uses the template makefile
approach on page 57-15.

You can switch from the toolchain approach to the template makefile approach with this command:

set_param(model, 'MakeCommand', 'make_rtw TMF=1')

Toolchain Approach
Toolchain settings appear under Build process when you set System target file to:

• grt.tlc — Generic Real-Time Target
• ert.tlc — Embedded Coder (requires the Embedded Coder product)
• ert_shrlib.tlc — Embedded Coder (host-based shared library target) (requires

Embedded Coder)
• Any toolchain-compliant system target file (If ERT-based, requires Embedded Coder)

For more information about toolchain-compliant system target files, see “Support Toolchain Approach
with Custom Target”.
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The Toolchain settings include these configuration parameters:

• “Toolchain” –– Specifies the collection of third-party software tools that builds the generated code.
A toolchain can include a compiler, linker, and archiver, and other prebuild or postbuild tools.

The default value of Toolchain is Automatically locate an installed toolchain. The
Toolchain parameter displays name of the located toolchain just below Automatically locate
an installed toolchain.

To check that the toolchain is present and validate that the code generator has the information
required to use the toolchain, in the Advanced Parameters section, click Validate Toolchain.
The resulting Validation Report gives a pass/fail value for the selected toolchain, and shows issues
that require resolution.

• “Build configuration” –– Specifies the optimization settings. By default, Build Configuration is
set to Faster Builds. You can also select Faster Runs, Debug, and Specify. If you select
Specify, you can customize the options for the toolchain. When you click Apply, the custom
toolchain settings apply to the current model.

Note The following system target files, which use the template makefile approach, have the same
names but different descriptions from system target files that use the toolchain approach:
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• ert.tlc — Create Visual C/C++ Solution File for Embedded Coder
• grt.tlc — Create Visual C/C++ Solution File for Simulink Coder

To avoid confusion, click Browse to select the system target file and look at the description of each
file.

Upgrade Model to Use Toolchain Approach
When you open a model created before R2013b that uses the following system target files, the
software tries to upgrade the model. The upgrade changes the configuration from using template
makefile settings to using the toolchain settings:

• ert.tlc — Embedded Coder
• ert_shrlib.tlc — Embedded Coder (host-based shared library target)
• grt.tlc — Generic Real-Time Target

Note To upgrade models using a custom system target file to use the toolchain approach, see
“Support Toolchain Approach with Custom Target” on page 86-58.

Some model configuration parameter values prevent the software from upgrading a model to use
toolchain settings. The following instructions show you ways to complete the upgrade process.

Consider upgrading your models and use the toolchain build approach. Doing so is not required. You
can continue generating code from a model that has not been upgraded.

Note The software does not upgrade models that use the following system target files:

• ert.tlc — Create Visual C/C++ Solution File for Embedded Coder
• grt.tlc — Create Visual C/C++ Solution File for Simulink Coder

To see if a model has been upgraded:

1 If the Toolchain and Build configuration configuration parameters are specified, the model has
been upgraded.
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If makefile configuration parameters such as Generate makefile, Make command, and
Template makefile are specified, the model has not been upgraded.

Start by creating a working copy of the model using File > Save As. This action preserves the
original model and configuration parameters for reference.

Try to upgrade the model using Upgrade Advisor:

1 On the Modeling tab, in the Evaluate & Manage section, select Upgrade Advisor.
2 In Upgrade Advisor, select Check and update model to use toolchain approach to build

generated code and click Run This Check.
3 Perform the suggested actions and/or click Update Model.

When you cannot upgrade the model using Upgrade Advisor, one or more of the following parameters
is not set to its default value, shown here:

• Compiler optimization level — Optimizations off (faster builds)
• Generate makefile — Enabled
• Template makefile — System target file-specific template makefile
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• Make command — make_rtw without arguments

Sometimes, a model cannot be upgraded. Try the following procedure:

• If Generate makefile is disabled, this case cannot be upgradable. However, you can try enabling
it and try upgrading the model using Upgrade Advisor.

• If Compiler optimization level is set to Optimizations on (faster runs):

1 Set Compiler optimization level is to Optimizations off (faster builds).
2 Upgrade the model using Upgrade Advisor.
3 Set Build configuration to Faster Runs.

• If Compiler optimization level is set to Custom:

1 Copy the Custom compiler optimization flags to a text file.
2 Set Compiler optimization level to Optimizations off (faster builds).
3 Upgrade the model using Upgrade Advisor.
4 Set Build configuration to Specify.
5 To perform the same optimizations, edit the compiler options.

• If Template makefile uses a customized template makefile, this case cannot be upgradable.
However, you can try the following:

1 Update Template makefile to use the default makefile for the system target file.

Note To get the default makefile name, change the System target file, click Apply, change
it back, and click Apply again.

2 Upgrade the model using Upgrade Advisor.
3 If the template makefile contains build tool options, such as compiler optimization flags, set

Build configuration to Specify and update the options.
4 If the template makefile uses custom build tools, create and register a custom toolchain, as

described in “Custom Toolchain Registration” . Then, set the Toolchain parameter to use the
custom toolchain.

Note After registering the custom toolchain, update Toolchain to use the custom toolchain.
5 If the template makefile contains custom rules and logic, these customizations cannot be

applied to the upgraded model.

Template Makefile Approach
When the System target file is set to a tlc file that uses the template makefile approach, the
software displays Compiler optimization level, Generate makefile, Make command, and
Template makefile parameters.
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Specify Whether to Generate a Makefile

The Generate makefile option specifies whether the build process is to generate a makefile for a
model. By default, the build process generates a makefile. Suppress generation of a makefile, for
example in support of custom build processing that is not based on makefiles, by clearing Generate
makefile. When you clear this parameter:

• The Make command and Template makefile options are unavailable.
• Set up post code generation build processing using a user-defined command, as explained in

“Customize Post-Code-Generation Build Processing”.

Specify a Make Command

Each template makefile-based system target file has an associated make command. The code
generator uses this internal MATLAB command to control the build process. The command appears in
the Make command field and runs when you start a build.

Most system target files use the default command, make_rtw. Third-party system target files could
supply another make command. See the documentation from the vendor.

In addition to the name of the make command, you can supply makefile options in the Make
command field. These options could include compiler-specific options, include paths, and other

57 Program Building, Interaction, and Debugging in Simulink Coder

57-16



parameters. When the build process invokes the make utility, these options are passed on the make
command line, which adds them to the overall flags passed to the compiler.

“Template Makefiles and Make Options” on page 57-21 lists the Make command options you can
use with each supported compiler.

Specify the Template Makefile

The Template makefile field has these functions:

• If you selected a system target file with the System Target File Browser, this field displays the
name of a MATLAB language file that selects a template makefile for your development
environment. For example, in “Model Configuration Parameters: Code Generation”, the Template
makefile field displays grt_default_tmf, indicating that the build process invokes
grt_default_tmf.m.

“Template Makefiles and Make Options” on page 57-21 gives a detailed description of the logic
by which the build process selects a template makefile.

• Alternatively, you can explicitly enter the name of a specific template makefile (including the
extension) or a MATLAB language file that returns a template makefile in this field. Use this
approach if you are using a system target file that does not appear in the System Target File
Browser. For example, use this approach if you have written your own template makefile for a
custom system target file.

If you specify your own template makefile, be sure to include the file name extension. If you omit the
extension, the build process attempts to find and execute a file with the extension .m (that is, a
MATLAB language file). The template make file (or a MATLAB language file that returns a template
make file) must be on the MATLAB path. To determine whether the file is on the MATLAB path, enter
the following command in the MATLAB Command Window:

which tmf_filename

Associate the Template Makefile with a Toolchain

Specify a toolchain for the template makefile build process. This example provides a definition for a
minimal toolchain and shows how you can associate the toolchain with a template makefile that is a
copy of ert_unix.tmf or ert_vcx64.tmf.

Use this code for the toolchain definition file.
function tc = minimalToolchainForTMF
% Create a toolchain object
tc = coder.make.ToolchainInfo('Name', 'Minimal Toolchain for TMF Build');

% Specify that the linker requires a response file instead of 
% including all object file modules on the linker command line
tc.addAttribute('RequiresCommandFile', true);

if ispc
    objExt = '.obj';
else
    objExt = '.o';
end

% Specify source file and object file extension used by the C compiler
tool = tc.getBuildTool('C Compiler');
tool.setFileExtension(  'Source', '.c');
tool.setFileExtension(  'Header', '.h');
tool.setFileExtension(  'Object',   objExt);
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% Specify source file and object file extension used by the C++ compiler
tool = tc.getBuildTool('C++ Compiler');
tool.setFileExtension(  'Source', '.cpp');
tool.setFileExtension(  'Header', '.hpp');
tool.setFileExtension(  'Object',   objExt);

Use a copy of ert_unix.tmf or ert_vcx64.tmf as the template makefile.
copyfile(fullfile(matlabroot, 'toolbox', 'coder', ...
                  'compile', 'tmf', 'ert_vcx64.tmf'), ...
                  'ert_copy.tmf')

In the template makefile, i.e. ert_copy.tmf, edit the TOOLCHAIN_NAME macro.

TOOLCHAIN_NAME = "Minimal Toolchain for TMF Build"

Associate the toolchain with the template make file.

1 Run the toolchain definition file, which generates a ToolchainInfo object, tc.

tc = minimalToolchainForTMF;
2 Save the ToolchainInfo object to a MAT file.

save('tcMinimal','tc')
3 Register the toolchain in RTW.TargetRegistry.

a Place this code in an rtwTargetInfo.m file.

function rtwTargetInfo(tr)
tr.registerTargetInfo(@loc_createToolchain);
end

function config = loc_createToolchain
config(1) = coder.make.ToolchainInfoRegistry;
config(1).Name = 'Minimal Toolchain for TMF Build';
config(1).FileName = fullfile(fileparts(mfilename('fullpath')),...
    'tcMinimal.mat');
config(1).TargetHWDeviceType = {'*'};
config(1).Platform =  {computer('arch')};
end

b Save the file in the current working folder or in a folder that is on the MATLAB search path.
c Reset the TargetRegistry.

RTW.TargetRegistry.getInstance('reset');

Associate the template makefile with your model and build the model.

set_param(model, 'TemplateMakefile', 'ert_copy.tmf');
slbuild(model);

Specify TLC for Code Generation
Target Language Compiler (TLC) is an integral part of the code generator. It enables you to customize
generated code. Through customization, you can produce platform-specific code, or you can
incorporate your own algorithmic changes for execution speed, code size, or compatibility with
existing methods that you prefer to maintain. For additional information, see “Target Language
Compiler Overview”.
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TLC options that you specify for code generation appear in the summary section of the generated
HTML code generation report.

Note Specifying TLC command-line options does not add flags to the make command line.

You can specify Target Language Compiler (TLC) command-line options and arguments for code
generation using the model parameter TLCOptions in a set_param function call. For example,
>> set_param(gcs,'TLCOptions','-p0 -aWarnNonSaturatedBlocks=0')

Some common uses of TLC options include the following:

• -aVarName=1 to declare a TLC variable and/or assign a value to it
• -IC:\Work to specify an include path
• -v to obtain verbose output from TLC processing (for example, when debugging)

Use of Checksums in Recompilation of Generated Code
When you build a model with GenerateMakefile set to 'on' and GenCodeOnly set to 'off', the
software generates a makefile and runs the makefile to compile the generated code. When the
compilation is complete, the software creates and saves checksums for source files and configuration
data.

If checksums from a previous build are available when you build the model:

1 The software uses the checksums to determine whether the source files and configuration data
are different from the previous build.

2 If the software detects a difference, the software:

• Regenerates the makefile.
• Recompiles the generated code.

If the build process uses a template makefile, you can disable the use of checksums by adding this
text to the template makefile:

DO_NOT_USE_CHECKSUMS=1

In this case, the software uses file timestamps to determine whether it should recompile the
generated code.

See Also

More About
• “Support Toolchain Approach with Custom Target” on page 86-58
• “Build Process Workflow for Real-Time Systems”
• “Custom Toolchain Registration”
• “Register Custom Toolchain and Build Executable”
• “Template Makefiles and Make Options” on page 57-21
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• “Target Language Compiler Overview”
• “Executable Program Generation” on page 57-47
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Template Makefiles and Make Options
The code generator includes a set of built-in template makefiles that build programs for specific
system target files.

Types of Template Makefiles
There are two types of template makefiles:

• Compiler-specific template makefiles are for a particular compiler or development system.

By convention, compiler-specific template makefiles names correspond to the system target file
and compiler (or development system). For example, grt_vcx64.tmf is the template makefile for
building a generic real-time program under the Visual C++ compiler; ert_lcc.tmf is the
template makefile for building an Embedded Coder program under the lcc compiler.

• Default template makefiles make your model designs more portable, by choosing the compiler-
specific makefile and compiler for your installation. “Select and Configure C or C++ Compiler” on
page 57-3 describes the operation of default template makefiles in detail.

Default template makefiles have names that follow the pattern target_default_tmf. They are
MATLAB language files that, when run, select the TMF for the specified system target file
configuration. For example, grt_default_tmf is the default template makefile for building a
generic real-time program; ert_default_tmf is the default template makefile for building an
Embedded Coder program.

For details on the structure of template makefiles, see “Customize Template Makefiles” on page 86-
43. This section describes compiler-specific template makefiles and common options you can use
with each.

Specify Template Makefile Options
You can specify template makefile options through the Make command configuration parameter.
Append the options after make_rtw (or other make command), as in the following example:

make_rtw OPTS="-DMYDEFINE=1"

The syntax for make command options differs slightly for different compilers.

Note To control compiler optimizations for a makefile build, use the Compiler optimization level
configuration parameter, which provides:

• System target file-independent values Optimizations on (faster runs) and
Optimizations off (faster builds), which easily allow you to toggle compiler
optimizations on and off during code development

• The value Custom for entering custom compiler optimization flags at Simulink GUI level (rather
than at other levels of the build process)

If you specify compiler options for your makefile build using OPT_OPTS, MEX_OPTS (except
MEX_OPTS="-v"), or MEX_OPT_FILE, the value of Compiler optimization level is ignored and a
warning is issued about the ignored parameter.
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Template Makefiles for UNIX Platforms
The template makefiles for UNIX platforms are for the Free Software Foundation's GNU Make. These
makefiles conform to the guidelines specified in the IEEE8 Std 1003.2-1992 (POSIX) standard.

• ert_unix.tmf
• grt_unix.tmf
• rsim_unix.tmf
• rtwsfcn_unix.tmf

You can supply options to makefiles through the Make command configuration parameter. Options
specified in Make command are passed to the command-line invocation of the make utility, which
adds them to the overall flags passed to the compiler. The following options can be used to modify the
behavior of the build:

• OPTS — User-specific options, for example,

OPTS="-DMYDEFINE=1"

• OPT_OPTS— Optimization options. Default is -O. To enable debugging, specify the option as
OPT_OPTS=-g. Because of optimization problems in IBM_RS, the default is to not optimize.

• CPP_OPTS — C++ compiler options.
• USER_SRCS — Additional user sources, such as files used by S-functions.
• USER_INCLUDES — Additional include paths, for example,

USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"

• DEBUG_BUILD — Add debug information to generated code, for example,

DEBUG_BUILD=1

These options are also documented in the comments at the head of the respective template makefiles.

Template Makefiles for the Microsoft Visual C++ Compiler
• “Visual C++ Executable Build” on page 57-22
• “Visual C++ Code Generation Only” on page 57-23

Visual C++ Executable Build

To build an executable using the Visual C++ compiler within the build process, use one of the
target_vcx64.tmf template makefiles:

• ert_vcx64.tmf
• grt_vcx64.tmf
• rsim_vcx64.tmf
• rtwsfcn_vcx64.tmf

You can supply options to makefiles through the Make command configuration parameter. Options
specified in Make command are passed to the command-line invocation of the make utility, which

8. IEEE is a registered trademark of The Institute of Electrical and Electronics Engineers, Inc.
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adds them to the overall flags passed to the compiler. The following options can be used to modify the
behavior of the build:

• OPT_OPTS — Optimization option. Default is -O2. To enable debugging, specify the option as
OPT_OPTS=-Zi.

• OPTS — User-specific options.
• CPP_OPTS — C++ compiler options.
• USER_SRCS — Additional user sources, such as files used by S-functions.
• USER_INCLUDES — Additional include paths, for example,

USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"
• DEBUG_BUILD — Add debug information to generated code, for example,

DEBUG_BUILD=1

These options are also documented in the comments at the head of the respective template makefiles.

Visual C++ Code Generation Only

To create a Visual C++ project makefile (model.mak) without building an executable, use one of the
target_msvc.tmf template makefiles:

• ert_msvc.tmf
• grt_msvc.tmf

These template makefiles are for nmake, which is bundled with the Visual C++ compiler.

You can supply options to makefiles through the Make command configuration parameter. Options
specified in Make command are passed to the command-line invocation of the make utility, which
adds them to the overall flags passed to the compiler. The following options can be used to modify the
behavior of the build:

• OPTS — User-specific options, for example,

OPTS="/D MYDEFINE=1"
• USER_SRCS — Additional user sources, such as files used by S-functions.
• USER_INCLUDES — Additional include paths, for example,

USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"
• DEBUG_BUILD — Add debug information to generated code, for example,

DEBUG_BUILD=1

These options are also documented in the comments at the head of the respective template makefiles.

Template Makefiles for the LCC Compiler
The code generator provides template makefiles to create an executable for the Windows platform
using Lcc compiler Version 2.4 and GNU Make (gmake).

• ert_lcc.tmf
• grt_lcc.tmf
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• rsim_lcc.tmf
• rtwsfcn_lcc.tmf

You can supply options to makefiles by using the Make command configuration parameter. Options
specified in the Make command field are passed to the command-line invocation of the make utility,
which adds them to the overall flags passed to the compiler. The following options can be used to
modify the behavior of the build:

• OPTS — User-specific options, for example,

OPTS="-DMYDEFINE=1"
• OPT_OPTS — Optimization options. Default is to not use options. To enable debugging, specify -

g4:

OPT_OPTS="-g4"
• CPP_OPTS — C++ compiler options.
• USER_SRCS — Additional user sources, such as files used by S-functions.
• USER_INCLUDES — Additional include paths. For example:

USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"

For lcc, use / as file separator before the file name instead of \, for example, d:\work\proj1/
myfile.c.

• DEBUG_BUILD — Add debug information to generated code, for example,

DEBUG_BUILD=1

These options are also documented in the comments at the head of the respective template makefiles.

See Also

More About
• “Configure a System Target File” on page 48-2
• “Customize System Target Files”
• “Associate the Template Makefile with a Toolchain” on page 57-17
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Build Process Workflow for Real-Time Systems
The building process includes generating code in C or C++ from a model and building an executable
program from the generated code. This example can use a generic real-time (GRT) or an embedded
real-time (ERT) system target file (STF) for code generation. The resulting standalone program runs
on your development computer, independent of external timing and events.

Working Folder
This example uses a local copy of the slexAircraftExample model, stored in its own folder,
aircraftexample. Set up your working folder as follows:

1 In the MATLAB Current Folder browser, navigate to a folder to which you have write access.
2 To create the working folder, enter the following MATLAB command:

mkdir aircraftexample
3 Make aircraftexample your working folder:

cd aircraftexample
4 Open the slexAircraftExample model:

slexAircraftExample

The model appears in the Simulink Editor model window.
5 In the model window, choose File > Save As. Navigate to your working folder,

aircraftexample. Save a copy of the slexAircraftExample model as
myAircraftExample.

Build Folder and Code Generation Folders
While producing code, the code generator creates a build folder within your working folder. The build
folder name is model_target_rtw, derived from the name of the source model and the chosen
system target file. The build folder stores generated source code and other files created during the
build process. Examine the build folder contents at the end of this example.

When a model contains Model blocks (references to other models), the model build creates special
subfolders in your “Code generation folder” to organize code for the referenced models. These code
generation folders exist alongside product build folders and are named slprj. For more information,
see “Generate Code for Model Reference Hierarchy”.

Under the slprj folder, a subfolder named _sharedutils contains generated code that can be
shared between models.

Set Model Parameters for Code Generation
To generate code from your model, you must change some of the model configuration parameters. In
particular, the generic real-time (GRT) system target file and most other system target files require
that the model specifies a fixed-step solver.

Note For models that specify variable-step solvers, the code generator produces code only if the
models also specify rapid simulation (rsim) or S-function system target files.
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1 Open the myAircraftExample model if it is not already open.
2 In the Configuration Parameters dialog box, specify configuration parameter values for the

solver:

• Start time: 0.0
• Stop time: 60
• Type: Fixed-step
• Solver: ode5 (Dormand-Prince)
• Fixed step size (fundamental sample time): 0.1
• Treat each discrete rate as a separate task: Off

3 Click Apply.
4 Save the model.

Configure Build Process
To configure the build process for your model, choose a system target file, a toolchain or template
makefile, and a make command.

In these examples and in most applications, you do not need to specify these parameters individually.
The examples use the ready-to-run generic real-time target (GRT) configuration. The GRT system
target file builds a standalone executable program that runs on your desktop computer.

To select the GRT system target file:

1 Open the myAircraftExample model if it is not already open.
2 In the Configuration Parameters dialog box, in the System target file field, enter grt.tlc.

Then click Apply.

You see selections for Toolchain (Automatically locate an installed toolchain), and
Build Configuration (Faster Builds).
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3 Save the model.

Note If you click Browse, a System Target File Browser opens and displays the system target files
on the MATLAB path. Some system target files require additional products. For example, ert.tlc
requires Embedded Coder.

Set Code Generation Parameters
1 Open the myAircraftExample model if it is not already open.
2 In the Configuration Parameters dialog box, specify settings:

a Use the default settings for the Code Generation advanced parameters, which control build
verbosity and debugging:

• Verbose build (RTWVerbose)
• Retain .rtw file (RetainRTWFile)
• Profile TLC (ProfileTLC)
• Start TLC debugger when generating code (TLCDebug)
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• Start TLC coverage when generating code (TLCCoverage)
• Enable TLC assertion (TLCAssert)

b Use the default Code Generation > Comments settings.
c The Code Generation > Identifiers options control the look and feel of generated code.

Use the default settings.
d Select Code Generation > Interface.

i From the Shared code placement list, select Shared location. The build process
places generated code for utilities in a subfolder within your “Code generation folder”.

ii Under the Advanced parameters, clear the Classic call interface check box.
iii Under the Advanced parameters, select the Single output/update function check

box.
e In Code Generation > Report, select Create code generation report and Open report

automatically. This action enables the software to create and display a code generation
report for the myAircraftExample model.

3 Click Apply and save the model.

Build and Run a Program
The build process generates C code from the model. It then compiles and links the generated
program to create an executable image. To build and run the program:

1 With the myAircraftExample model open, perform one of these actions:

• On the Apps tab, open the Simulink Coder app. In the C Code tab, click Build.
• Press Ctrl+B.
• Run the slbuild command from the MATLAB command line.
• Run the slbuild command from the MATLAB command line.

You see code generation and compilation messages in the Command Window. The initial message
is:
### Starting build procedure for model: myAircraftExample

The contents of many of the succeeding messages depends on your compiler and operating
system. The final messages include:
### Created executable myAircraftExample.exe
### Successful completion of build procedure for model: myAircraftExample
### Creating HTML report file myAircraftExample_codegen_rpt.html

The code generation folder now contains an executable, myAircraftExample.exe (Microsoft
Windows platforms) or myAircraftExample (UNIX platforms). In addition, the build process
has created an slprj folder and a myAircraftExample_grt_rtw folder in your “Code
generation folder”.

Note After generating the code for the myAircraftExample model, the build process displays
a code generation report. See “Report Generation” for more information about how to create and
use a code generation report.

2 To see the contents of the working folder after the build, enter the dir or ls command:
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>> dir

.                               myAircraftExample.slx           slprj

..                              myAircraftExample.slx.autosave
myAircraftExample.exe           myAircraftExample_grt_rtw

3 To run the executable from the Command Window, type !myAircraftExample. The ! character
passes the command that follows it to the operating system, which runs the standalone
myAircraftExample program.
>> !myAircraftExample

** starting the model **
** created myAircraftExample.mat **

4 To see the files created in the build folder, use the dir or ls command again. The exact list of
files produced varies among MATLAB platforms and versions. Here is a sample list from a
Windows platform:
>> dir myAircraftExample_grt_rtw

.                     rt_main.obj                  myAircraftExample_data.c

..                    rtmodel.h                    myAircraftExample_data.obj
buildInfo.mat         rtw_proj.tmw                 myAircraftExample_private.h
codeInfo.mat          myAircraftExample.bat        myAircraftExample_ref.rsp
defines.txt           myAircraftExample.c          myAircraftExample_types.h
html                  myAircraftExample.h
modelsources.txt      myAircraftExample.mk
rt_logging.obj        myAircraftExample.obj

Contents of the Build Folder
The build process creates a build folder and names it model_target_rtw, where model is the name
of the source model and target is the system target file selected for the model. In this example, the
build folder is named myAircraftExample_grt_rtw.

The build folder includes the following generated files.

File Description
myAircraftExample.c Standalone C code that implements the model
myAircraftExample.h An include header file containing definitions of

parameters and state variables
myAircraftExample_private.h Header file containing common include definitions
myAircraftExample_types.h Forward declarations of data types used in the code
rtmodel.h Master header file for including generated code in the

static main program (its name does not change, and it
simply includes myAircraftExample.h)

The code generation report that you created for the myAircraftExample model displays a link for
each of these files. You can click the link explore the file contents.

The build folder contains other files used in the build process. They include:

• myAircraftExample.mk — Makefile for building executable using the specified Toolchain.
• Object (.obj) files
• myAircraftExample.bat — Batch control file
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• rtw_proj.tmw — Marker file
• buildInfo.mat — Build information for relocating generated code to another development

environment
• defines.txt — Preprocessor definitions required for compiling the generated code
• myAircraftExample_ref.rsp — Data to include as command-line arguments to mex (Windows

systems only)

The build folder also contains a subfolder, html, which contains the files that make up the code
generation report. For more information, see “Reports for Code Generation”.

Customized Makefile Generation
After producing code, the code generator produces a customized makefile, model.mk. The generated
makefile instructs the make system utility to compile and link source code generated from the model,
any required harness program, libraries, or user-provided modules. The code generator produces the
file model.mk regardless of the approach that you use for build process control:

• If you use the toolchain approach, the code generator creates model.mk based on the model
Toolchain settings. You can modify generation of the makefile through the rtwmakecfg.m API.

• If you use the template makefile approach, the code generator creates model.mk from a system
template file, system.tmf (where system stands for the selected system target file name). The
system template makefile is designed for your system target file. You can modify the template
makefile to specify compilers, compiler options, and additional information for the creation of the
executable.

For more information, see “Choose Build Approach and Configure Build Process” on page 57-11.

See Also

More About
• “Choose Build Approach and Configure Build Process” on page 57-11
• “Manage Build Process Folders”
• “Reports for Code Generation”
• “Select and Configure C or C++ Compiler” on page 57-3
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Build Models from a Windows Command Prompt Window
This example shows how to build models by using a batch file, entering commands at the Command
Prompt in Windows.

About MATLAB Command-Line (Start Up) Arguments

When you start MATLAB from a Command Prompt in Windows (as done in a batch file), you can
control MATLAB start up with a number of command-line arguments.

For a description of these command-line arguments, in the Command Prompt window, type matlab -
help.

To start MATLAB from a Command Prompt window, use these steps:

1 From the Windows Start menu, open a Command Prompt window.
2 From the Windows Command Prompt, type: matlab.

Tip: To display the path to the MATLAB root folder, at the MATLAB command prompt type:
matlabroot.

Run MATLAB with a Batch File

When you run MATLAB with a batch file, you can:

• Control MATLAB start up with command-line arguments
• Run a series of operating system commands (such as source control checkout/commit)
• Run a series of MATLAB scripts

A batch approach also lets you automate your overall build process. Such a process can generate
code from one or more Simulink models, then use your makefile to compile custom code and
generated code.

This batch file sets the MATLABROOT environment variable, sets the PATH environment variable to
include MATLABROOT, and starts MATLAB with an input script argument %1 and a logfile argument.

Note: Customize the MATLABROOT value in the batch file to match your system. The batch file
assumes that a c:\temp folder exists on your system.

Create a batch file named mat.bat

SET MATLABROOT="C:\Program Files\MATLAB\R2019a"
PATH=%MATLABROOT%;%PATH%
START matlab.exe -batch %1 -logfile c:\temp\logfile
PAUSE

Create a MATLAB script myFilesToBuild.m

my_rtwdemo_counter_builder
my_rtwdemo_rtwintro_builder
exit

Create a MATLAB script my_rtwdemo_counter_builder.m

open_system('rtwdemo_counter');
save_system('rtwdemo_counter','my_rtwdemo_counter')
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slbuild('my_rtwdemo_counter');
close_system('my_rtwdemo_counter');

Create a MATLAB script my_rtwdemo_rtwintro_builder.m

open_system('rtwdemo_rtwintro');
save_system('rtwdemo_rtwintro','my_rtwdemo_rtwintro')
slbuild('my_rtwdemo_rtwintro');
close_system('my_rtwdemo_rtwintro');

Run the batch file

From the Windows Start menu, open a Command Prompt window, change folders to the folder
containing the batch file, and type:

mat myFilesToBuild

When you run the batch file with the input MATLAB script, the batch file runs MATLAB and loads,
builds, and closes each of the example Simulink models.

Observe the log of MATLAB operations

After the batch file runs, view the c:\temp\logfile file.

Tip: Omitting the semicolon (;) from the slbuild line in each script provides more build information
in the log file.

Optimize Your Batch File

Use the MATLAB command-line arguments to optimize the batch file. Some options to consider
include:

• Suppress the MATLAB splash screen on startup with the -nosplash argument.
• Provide command-line input to the input script or function selected with the -batch argument.

For example, you can call a function myfile.m, which accepts two arguments:

matlab -batch myfile(arg1,arg2)

To pass numeric values into myfile.m, replace arg1 and arg2 with numeric values.

To pass string or character values into myfile.m, replace arg1 and arg2 with the string or
character values surrounded in single quotes. For example, to pass the string values hello and
world into myfile.m, in the Command Prompt window, type:

matlab -batch myfile('hello','world')

Copyright 2007-2019 The MathWorks, Inc.

See Also

More About
• matlab (Windows)
• “Compile and Debug Generated C Code with Microsoft® Visual Studio®”
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Rebuild a Model
If you update generated source code or makefiles manually to add customizations, you can rebuild
the files with the rtwrebuild command. This command recompiles the modified files by invoking the
generated makefile. Alternatively, you can rebuild from the Model Explorer:

1 Open the Model Explorer
2 In the Model Hierarchy pane, expand the node for the model.
3 Click the Code for model node.
4 In the Code pane, next to Code Recompile Command, click rebuild generated code.

See Also

More About
• rtwrebuild
• “Build Process Workflow for Real-Time Systems”
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Control Regeneration of Top Model Code
When you rebuild a model, by default, the build process performs checks to determine whether
changes to the model or relevant settings require regeneration of the top model code. The model
build regenerates top model code if any of the following conditions is true:

• The structural checksum of the model has changed.
• The top-model-only checksum has changed. The top-model-only checksum provides information

about top model parameters, such as application lifespan, maximum stack size, make command,
verbose and .rtw file debug settings, and TLCOptions.

• Any of the following TLC debugging configuration parameters is selected:

• Start TLC debugger when generating code (TLCDebug)
• Start TLC coverage when generating code (TLCCoverage)
• Enable TLC assertion (TLCAssert)
• Profile TLC (ProfileTLC)

Whether the top model code is regenerated, the build process calls the build process hooks and
reruns the makefile. The hooks include the STF_make_rtw_hook functions and the post code
generation command. This process recompiles and links the external dependencies.

System target file authors can perform actions related to code regeneration in the
STF_make_rtw_hook functions that the build process calls. These actions include forcing or reacting
to code regeneration. For more information, see “Control Code Regeneration Using
STF_make_rtw_hook.m” on page 85-38.

Regeneration of Top Model Code
If the checks determine that top model code generation is required, the build process fully
regenerates and compiles the model code. An example check is whether previously generated code is
not current due to a model update.

The build process omits regeneration of the top model code when the checks indicate both:

• The top model generated code is current for the model.
• Model settings do not require full regeneration.

This omission can significantly reduce model build times.

With an Embedded Coder license, if you modify a code generation template (CGT) file then rebuild
your model, the code generation process does not force a top model build. In this case, see “Force
Regeneration of Top Model Code” on page 57-34.

Force Regeneration of Top Model Code
If you want to control or override the default top model build behavior, use one of the following
command-line options:

• To ignore the checksum and force regeneration of the top model code:
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• slbuild>(model,'ForceTopModelBuild',true)
• slbuild(model,'StandaloneCoderTarget','ForceTopModelBuild',true)

• To clean the model build area enough to trigger regeneration of the top model code at the next
build (slbuild only):

slbuild(model,'CleanTopModel')

You can force regeneration of the top model code by deleting the slprj folder or the generated
model code folder from the “Code generation folder” .

See Also
codebuild

More About
• “Control Code Regeneration Using STF_make_rtw_hook.m” on page 85-38
• “Choose Build Approach and Configure Build Process” on page 57-11
• “Rebuild a Model” on page 57-33
• “Reduce Build Time for Referenced Models by Using Parallel Builds” on page 57-36
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Reduce Build Time for Referenced Models by Using Parallel
Builds

For models that contain large model reference hierarchies, you can reduce code generation and
compilation time by building the referenced models in parallel. With Parallel Computing Toolbox
software, you can distribute the code generation and compilation for referenced models across a
parallel pool of MATLAB workers. If you also have MATLAB Parallel Server™ software, you can
distribute the code generation and compilation across remote workers in your MATLAB Parallel
Server configuration.

Build Referenced Models in Parallel
To build referenced models in parallel:

1 Open the Configuration Parameters dialog box for the top model of the model hierarchy.
2 Select the Enable parallel model reference builds check box.
3 For each MATLAB worker, you can set up a MATLAB environment that is consistent with the

MATLAB environment of the client. From the MATLAB worker initialization for builds drop-
down list, select one of these values:

• None –– Simulink does not initialize workers.
• Copy base workspace –– Simulink attempts to copy the base workspace to each MATLAB

worker.
• Load top model –– Simulink loads the top model onto each MATLAB worker.

4 Build your model from the command line or the Simulink Editor Code perspective:

• Command line –– Use, for example, slbuild. The build process displays build log messages
in the Command Window.

• Simulink Editor Code perspective –– Click the Build button. The build process displays build
log messages in the Diagnostic Viewer.

If the Parallel Computing Toolbox parallel preference Automatically create a parallel pool
is selected, a parallel pool of MATLAB workers is automatically started. For more information,
see “Specify Your Parallel Preferences” (Parallel Computing Toolbox).

If a parallel pool of MATLAB workers is not running when you build your model, MATLAB
automatically opens a parallel pool of workers by using the default cluster profile. To change
the default behaviour of the worker cluster, you can modify properties of the cluster profile. If
you have not touched your parallel preferences, the default profile is local. Control parallel
behavior with the parallel preferences, including scaling up to a cluster, automatic pool
creation, and preferred number of workers. For more information, see “Discover Clusters and
Use Cluster Profiles” (Parallel Computing Toolbox).

For more general information about parallel computing, see “Run MATLAB Functions with
Automatic Parallel Support” (Parallel Computing Toolbox).

Monitor Parallel Building of Referenced Models
Through the Build Status window, you can:
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• View the overall build progress for a model hierarchy.
• View the build status of individual models in the model hierarchy.
• Cancel the parallel build process.

Note The Build Status window supports only parallel building of model hierarchies. Do not use the
Build Status window for serial builds.

To open the Build Status window, use one of these line commands:

• coder.buildstatus.open('model')
• slbuild('model', ... 'OpenBuildStatusAutomatically',true)
• slbuild('model','StandaloneCoderTarget', ...

'OpenBuildStatusAutomatically',true)

This example shows how you can monitor the build process for a model hierarchy. In the hierarchy,
rtwdemo_parabuild_a_1 references rtwdemo_parabuild_b_1, rtwdemo_parabuild_b_2, and
rtwdemo_parabuild_b_3.

1 Copy the model files to a local folder.
src_dir = ...
    fullfile(matlabroot,'toolbox','rtw','rtwdemos');
if exist(fullfile('.','myTempFolder'),'dir')
    rmdir('myTempFolder','s')
end
mkdir myTempFolder

copyfile(fullfile(src_dir,'rtwdemo_parabuild_a_1.slx'), ...
         'myTempFolder');
copyfile(fullfile(src_dir,'rtwdemo_parabuild_b_1.slx'), ...
         'myTempFolder');
copyfile(fullfile(src_dir,'rtwdemo_parabuild_b_2.slx'), ...
         'myTempFolder');
copyfile(fullfile(src_dir,'rtwdemo_parabuild_b_3.slx'), ...
         'myTempFolder');

cd myTempFolder

2 Open the top model.
open_system('rtwdemo_parabuild_a_1')
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3 View the model dependencies with the Dependency Analyzer. On the Modeling tab, on the far
right of the Design section, click the arrow. Then, under System Design, click Dependency
Analyzer.
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4 Start parallel building of the model hierarchy and open the Build Status window.
slbuild('rtwdemo_parabuild_a_1','OpenBuildStatusAutomatically',true)

The Build Status window displays the overall build progress and the build status for models as
the code generator works through the model hierarchy.

This table explains the Status column values.

Status Description
Blocked The code generator cannot schedule the model build because the build is

blocked by dependencies. For example, a child model build is not complete.
Scheduled In parallel building, the code generator schedules a model build when the

build is not blocked by dependencies. The status of the model build is
Scheduled until a parallel pool worker becomes available.

Building The model is being built on a worker.
Completed When a model is built without errors, the status changes to Completed.
Error If the model build fails, the status changes to Error.
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Status Description
Up To Date Code generation is not required for the model because the current

generated code is up to date.
Canceling When you click the Cancel Build button, the build process changes the

status of incomplete builds to Canceling.
Canceled The canceling operation is complete.

The Elapsed Time column shows the build times for models in the hierarchy. To reduce the total
build time, analyse the build times for referenced models together with model dependency
information. Then, consider, for example:

• Restructuring the referenced model hierarchy.
• Increasing the number of workers in the parallel pool.

See Also
coder.buildstatus.close | coder.buildstatus.open | slbuild

More About
• “Control Regeneration of Top Model Code” on page 57-34
• “Reduce Update Time for Referenced Models by Using Parallel Builds”
• “Build Process Workflow for Real-Time Systems”
• “Profile Code Execution Speed” on page 57-49
• “Support Model Referencing” on page 86-60
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Relocate Code to Another Development Environment
If you require relocating the static and generated code files for a model to another development
environment, use the pack-and-go utility. This condition occurs when your system or integrated
development environment (IDE) does not include MATLAB and Simulink products.

Code Relocation
The pack-n-go utility uses the tools for customizing the build process after code generation and a
packNGo function to find and package files for building an executable image. The files are packaged
in a compressed file that you can relocate and unpack using a standard zip utility.

Package Code Using the User Interface
To package and relocate code for your model using the user interface:

1 In the Configuration Parameters dialog box, select Package code and artifacts. This option
configures the build process to run the packNGo function after code generation to package
generated code and artifacts for relocation.

2 In the Zip file name field, enter the name of the zip file in which to package generated code
and artifacts for relocation. You can specify the file name with or without the .zip extension. If
you do not specify an extension or an extension other than .zip, the zip utility adds the.zip
extension. If you do not specify a value, the build process uses the name model.zip, where
model is the name of the top model for which code is being generated.
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3 Apply changes and generate code for your model. To verify that it is ready for relocation, inspect
the resulting zip file. Depending on the zip tool that you use, you could be able to open and
inspect the file without unpacking it.

4 Relocate the zip file to the destination development environment and unpack the file.

Package Code Using the Command-Line Interface
To package and relocate code for your model using the command-line interface:

1 Select a structure for the zip file. on page 57-42
2 Select a name for the zip file. on page 57-43
3 Package the model code files in the zip file. on page 57-43
4 Inspect the generated zip file. on page 57-44
5 Relocate and unpack the zip file. on page 57-44

Select a Structure for the Zip File

Before you generate and package the files for a model build, decide whether you want the files to be
packaged in a flat or hierarchical folder structure. By default, the packNGo function packages the
files in a single, flat folder structure.
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If... Then Use a...
You are relocating files to an IDE that does not
use the generated makefile, or the code is not
dependent on the relative location of required
static files

Single, flat folder structure

The destination development environment must
maintain the folder structure of the source
environment because it uses the generated
makefile, or the code depends on the relative
location of files

Hierarchical structure

If you use a hierarchical structure, the packNGo function creates two levels of zip files, a primary
zip file, which in turn contains the following secondary zip files:

• mlrFiles.zip — files in your matlabroot folder tree
• sDirFiles.zip — files in and under your build folder where you initiated code generation for

the model
• otherFiles.zip — required files not in the matlabroot or start folder trees

Paths for the secondary zip files are relative to the root folder of the primary zip file, maintaining
the source development folder structure.

Select a Name for the Zip File

By default, the packNGo function names the primary zip file model. You have the option of
specifying a different name. If you specify a file name and omit the file type extension, the function
appends . to the name that you specify.

Package Model Code in a Zip File

Package model code files by using the PostCodeGenCommand configuration parameter, packNGo
function, and build information object for the model. You can set up the packaging operation to use:

• A system generated build information object.

In this case, before generating the model code, use set_param to set the configuration parameter
PostCodeGenCommand to an explicit call to the packNGo function. For example:
set_param(bdroot, 'PostCodeGenCommand', 'packNGo(buildInfo);');

After generating and writing the model code to disk and before generating a makefile, this
command instructs the build process to evaluate the call to packNGo. This command uses the
system generated build information object for the currently selected model.

• A build information object that you construct programmatically.

In this case, you could use other build information functions to include paths and files selectively
in the build information object that you then specify with the packNGo function. For example:
.
.
.
myModelBuildInfo = RTW.BuildInfo;
addSourceFiles(myModelBuildInfo, {'test1.c' 'test2.c' 'driver.c'});
.
.

 Relocate Code to Another Development Environment

57-43



.
packNGo(myModelBuildInfo);

The following examples show how you can change the default behavior of packNGo.

To... Specify...
Change the structure of the file packaging
to hierarchical

packNGo(buildInfo, 'packType' 'hierarchical');

Rename the primary zip file packNGo(buildInfo, 'fileName' 'zippedsrcs');
Change the structure of the file packaging
to hierarchical and rename the primary zip
file

packNGo(buildInfo, 'packType' 'hierarchical'...
'fileName' 'zippedsrcs');

Include header files found on the include
path in the zip file

packNGo(buildInfo, 'minimalHeaders' false);

Generate warnings for parse errors and
missing files

packNGo(buildInfo, 'ignoreParseError' true...
'ignoreFileMissing' true);

Note The packNGo function can potentially modify the build information passed in the first packNGo
argument. As part of packaging model code, packNGo could find additional files from source and
include paths recorded in build information for the model and add them to the build information.

Inspect a Generated Zip File

To verify that it is ready for relocation, inspect the generated zip file. Depending on the zip tool that
you use, you could be able to open and inspect the file without unpacking it. If unpacking the file and
you packaged the model code files as a hierarchical structure, unpacking requires you to unpack the
primary and secondary zip files. When you unpack the secondary zip files, relative paths of the files
are preserved.

Relocate and Unpack a Zip File

Relocate the generated zip file to the destination development environment and unpack the file.

Code Packaging Example

This example shows how to package code files generated for the example model rtwdemo_rtwintro
using the command-line interface:

1 Set your working folder to a writable folder.
2 Open the model rtwdemo_rtwintro and save a copy to your working folder.
3 Enter the following MATLAB command:

set_param('rtwdemo_rtwintro', 'PostCodeGenCommand',...
'packNGo(buildInfo, ''packType'' ''hierarchical'')');

You must double the single-quotes due to the nesting of character arrays 'packType' and
'hierarchical' within the character array that specifies the call to packNGo.

4 Generate code for the model.
5 Inspect the generated zip file, rtwdemo_rtwintro.zip. The zip file contains the two

secondary zip files, mlrFiles.zip and sDirFiles.zip.
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6 Inspect the zip files mlrFiles.zip and sDirFiles.zip.
7 Relocate the zip file to a destination environment and unpack it.

Limitations
packNGo Function

For information about limitations that apply to this function, see packNGo.

Executable File with Nondefault Extension

If a build process uses the template makefile approach, then packNGo uses the executable file
extension specified by the linker tool to determine binary artifacts that require packaging.

If you generate an executable file with an extension that is not a default value, check that the
extension is saved in the toolchain associated with the template makefile. For more information, see
“Associate the Template Makefile with a Toolchain”.

If the build process generates an executable file with an extension that is different from the extension
saved in the toolchain, packNGo does not package the executable file.

See Also

More About
• packNGo
• “Choose Build Approach and Configure Build Process” on page 57-11
• “Build Process Workflow for Real-Time Systems”
• “Executable Program Generation” on page 57-47
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Compile and Debug Generated C Code with Microsoft® Visual
Studio®

This example shows how to generate code from a model and produce a Visual Studio Solution. For the
base example, see rtwdemo_counter.

About This Example

Building this example model generates a Visual Studio Solution. These model configuration
parameter settings control this code generation:

• Set System target file to grt.tlc.
• Set Template makefile to RTW.MSVCBuild.

When you build the model with this configuration, Simulink Coder generates code in a Visual Studio
Solution. Add this solution to a Visual Studio C/C++ project to integrate generated code with your
custom Visual Studio code.

Before You Start

• This example builds code for Microsoft Visual Studio running on Microsoft Windows® platforms.
• This example works with Microsoft Visual Studio, but not with Visual Studio Express.
• Simulink Coder uses the GRT code format, which is intended for rapid prototyping.
• Embedded Coder uses the ERT code format, which is intended for production deployment.

Example Steps

1 Open the example model rtwdemo_counter_msvc. In the Command Window, type:
open_system('rtwdemo_counter_msvc');.

2 To generate debug output in the generated Visual Studio Solution, set the model configuration
parameter Make command to make_rtw DEBUG_BUILD=1. (Omit this step if debug output is
not required in the solution.)

3 To generate code and build a program executable, initiate the build process.
4 After the build process is complete, you can see a Visual Studio Solution was generated and

placed in the msvc folder under folder rtwdemo_counter_msvc_grt_rtw.
5 In Microsoft Visual Studio, open the rtwdemo_counter_msvc.sln solution file.

Use the solution to build and debug the generated code in Visual Studio.

See Also

Related Examples
• “Choose an External Code Integration Workflow”
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Executable Program Generation
The following figure shows how the process for program building.

During the final stage of processing, the build process invokes the generated makefile, model.mk,
which in turn compiles and links the generated code. On PC platforms, a batch file is created to
invoke the generated makefile. The batch file sets up the environment for invoking the make utility
and related compiler tools. To avoid recompiling C files, the make utility performs date checking on
the dependencies between the object and C files; only out-of-date source files are compiled.
Optionally, the makefile can download the resulting executable image to your target hardware.

This stage is optional, as illustrated by the control logic in the preceding figure. You could choose to
omit this stage (for example, if you are targeting an embedded microcontroller board).

To omit this stage of processing, in the Configuration Parameters dialog box, select the Generate
code only check box. You can then cross-compile your code and download it to your target hardware.

If you also select the Create code generation report check box, the code generator produces an
HTML report. To view the report, on the C Code tab, select Open Latest Report. This example is a
code generation report for a generic real-time (GRT) system target file.
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See Also

More About
• “Choose Build Approach and Configure Build Process” on page 57-11
• “Build Process Workflow for Real-Time Systems”
• “Executable Program Generation” on page 57-47
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Profile Code Execution Speed
By profiling the execution speed of generated code, you can help verify that the code meets execution
speed requirements.

Profiling can be especially important early in the development cycle for identifying potential
architectural issues that can be more expensive to address later in the process. Profiling can also
identify bottlenecks and procedural issues that indicate a need for optimization, for example, with an
inner loop or inline code.

Note If you have an Embedded Coder license, see “Code Execution Profiling” for an alternative and
simpler approach based on software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulations.

Use the Profile Hook Function Interface
You can profile code generated with code generation technology by using a Target Language
Compiler (TLC) hook function interface.

To use the profile hook function interface:

1 For your system target file, create a TLC file that defines the following hook functions. Write the
functions so that they specify profiling code. The code generator adds the hook function code to
code generated for atomic systems in the model.

Function Input Arguments Output Type Description
ProfilerHeaders void Array of header file

names
Return an array of the
header file names to be
included in the generated
code.

ProfilerTypedefs void typedefs Generate code
statements for profiler
type definitions.

ProfilerGlobalData system Global data for the
specified system

Generate code
statements that declare
global data.

ProfilerExtern‐
DataDecls

system extern declarations for
the specified system

Generate code
statements that create
global extern
declarations.

ProfilerSystemDecls system, functionType Declarations for the
specified system for the
specified functionType

Generate code for
required variable
declarations within the
scope of an atomic
subsystem Output,
Update, OutputUpdate,
or Derivatives
function.
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Function Input Arguments Output Type Description
ProfilerSystemStart system, functionType Profiler start commands

for the specified system
and functionType

Generate code that starts
the profiler within the
scope of an atomic
subsystem Output,
Update, OutputUpdate,
or Derivatives
function.

ProfilerSystem‐
Finish

system, functionType Profiler end commands
for the specified system
and functionType

Generate code that stops
the profiler within the
scope of the Output,
Update, OutputUpdate,
or Derivatives
functions of an atomic
subsystem.

ProfilerSystem‐
Terminate

system Profiler termination code
for the specified system

Generate code that
terminates profiling (and
possibly reports results)
for an atomic subsystem.

2 In your target.tlc file, define the following global variables.

Define... To Be...
ProfileGenCode TLC_TRUE or 1 to turn on profiling (TLC_FALSE or 0 to

turn off profiling)
ProfilerTLC The name of the TLC file that you created in step 1

A quick way to define global variables is to define the parameters with the -a option. You can
apply this option by using the set_param command to set the model configuration parameter
TLCOptions. For example,

>> set_param(gcs,'TLCOptions', ...
     '-aProfileGenCode=1 -aProfilerTLC="rtwdemo_profile_hook.tlc"')

3 Consider setting configuration parameters for generating a code generation report. You can then
examine the profiling code in the context of the code generated for the model.

4 Build the model. The build process embeds the profiling code in the hook function locations in
the generated code for the model.

5 Run the generated executable file. In the MATLAB Command Window, enter !model-name. You
see the profiling report you programmed in the profiling TLC file that you created. For example, a
profile report could list the number of calls made to each system in a model and the number of
CPU cycles spent in each system.

For details on programming a .tlc file and defining TLC configuration variables, see “Target
Language Compiler”.

Profile Hook Function Interface Limitation
The TLC hook function interface for profiling code execution speed does not support the S-function
system target file (rtwsfcn.tlc).
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See Also

More About
• “Build Process Workflow for Real-Time Systems”
• “Code Execution Profiling”
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Host/Target Communication in Simulink
Coder

• “External Mode Simulations for Parameter Tuning and Signal Monitoring” on page 58-2
• “External Mode Simulation by Using XCP Communication” on page 58-7
• “Graphical Controls for XCP External Mode Simulations” on page 58-21
• “Set Up Connectivity Between Simulink and Target Hardware” on page 58-28
• “Customize XCP Slave Software” on page 58-35
• “External Mode Simulation with TCP/IP or Serial Communication” on page 58-44
• “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 58-82
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External Mode Simulations for Parameter Tuning and Signal
Monitoring

You can use external mode simulations for rapid prototyping. An external mode simulation establishes
a communication channel between Simulink on your development computer (host) and the target
hardware that runs the executable file created by the code generation and build process.

Through the communication channel, you can:

• Modify or tune block parameters in real time. When you change parameters in your model,
Simulink downloads the new values to the executing target application.

• Monitor and save signal data from the executing target application.

The low-level transport layer of the channel handles the transmission of messages. Simulink and the
generated model code are independent of this layer. The transport layer and its interface code are
isolated in separate modules that format, transmit, and receive messages and data packets.

58 Host/Target Communication in Simulink Coder

58-2



Communication Mechanisms for External Mode
Simulink supports two communication mechanisms for external mode simulation. To decide which
mechanism to use, see the information in this table.

Communication
Mechanism

Supports Reasons for Selecting Communication
Mechanism

XCP, the Universal
Measurement and
Calibration Protocol

ERT and GRT system target
files.

Some Simulink support
packages. For details, see
https://www.mathworks.com/
hardware-support.html?
q=&page=1.

XCP external mode:

• Uses a standard communication
protocol.

• Requires only a lightweight
communication software stack on the
target hardware.

• Supports signal logging and streaming
for Dashboard blocks and the
Simulation Data Inspector. You can
stream signals from within a
referenced model hierarchy.

• Provides documented ext_mode.h API
for external mode target connectivity.

• Supports streaming of execution-time
metrics to the Simulation Data
Inspector for host-based and support
package external mode simulations.

For information about running XCP
external mode simulations, see:

• “External Mode Simulation by Using
XCP Communication” on page 58-7

• “Customize XCP Slave Software” on
page 58-35

TCP/IP and serial
(RS-232)

ERT, GRT, and RSim system
target files.

Simulink support packages.

XCP external mode simulations do not
support your target hardware because of
known limitations.

For information about running TCP/IP and
serial external mode simulations, see:

• “External Mode Simulation with TCP/IP
or Serial Communication” on page 58-
44

• “Create a Transport Layer for TCP/IP
or Serial External Mode
Communication” on page 58-82

Simulink Feature Support for External Mode
This table summarizes feature support for both forms of external mode simulations.
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Feature XCP Support TCP/IP and Serial
Support

Parameter tuning With Dashboard blocks Yes Yes
Of tunable block parameters Yes Yes

Simulation Data Inspector Yes. Includes signals
within referenced
models.

No

Logic Analyzer Yes. Includes signals
within referenced
models.

No

Blocks that receive
and display signals
from target
application

Dashboard Yes No
Floating Scope, Scope Yes Yes
Spectrum Analyzer, Time Scope
(DSP System Toolbox)

Yes Yes

Display Yes Yes
To Workspace Yes Yes
User-written S-Function.

A method, which enables user-
written blocks to support
external mode, is built into the
S-function API.

See matlabroot/simulink/
include/simstruc.h.

Yes Yes

XY Graph Yes Yes
Signal Viewing Subsystem on page 58-63 Yes Yes

External Mode Simulations by Using the Run on Custom Hardware App
To run external mode simulations on your development computer or target hardware that is not
supported by MathWorks support packages, use the Run on Custom Hardware app. For an external
mode simulation, you:

1 Build the target application on your development computer.
2 Deploy the target application to the target hardware.
3 Connect Simulink to the target application that runs on the target hardware.
4 Start execution of generated code on the target hardware.

With the app, you can perform the steps separately or by using one-click. This table shows the
workflow support that the app provides for your target hardware.
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Workflow Feature or Task Target Hardware
Development
Computer

Custom Hardware

One-click 

Yes Yes, if you set up
connectivity on page 58-
28 between Simulink and
your target hardware.

Step-by-step
Build for Monitoring 

Yes Yes. Software builds target
application on development
computer by using the
toolchain that you specify.

Deploy 
Yes Yes, if you set up

connectivity on page 58-
28 between Simulink and
your target hardware.

Connect 
Yes Yes

Start 
Yes Yes

External Mode Control Panel
Using the External Mode Control Panel, you can perform some of the functions that the Run on
Custom Hardware app provides, for example, Connect, Start, and Disconnect. You can also open
the External Signal & Triggering dialog box, which enables you to:

• Select logged signals that you want to monitor.
• Configure a trigger for uploading target application data.

For details, see XCP panel on page 58-22 or TCP/IP and serial panel on page 58-50.

Security for External Mode Simulations
Ensure that access to your development computer and the target hardware is secure.

Provide a secure communication channel between your development computer and the target
application by applying the security measures listed in this table.

Communication Protocol Security Measure
XCP on TCP/IP, TCP/IP Run your development computer and target

application within a trusted private network or virtual
private network (VPN).

XCP on serial, serial Use a point-to-point link between your development
computer and target application, for example, a serial
cable.

Before generating code for production, to reduce the risk of unintended access to the target
application, disable external mode settings.
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See Also

More About
• “External Mode Simulation by Using XCP Communication” on page 58-7
• “Customize XCP Slave Software” on page 58-35
• “External Mode Simulation with TCP/IP or Serial Communication” on page 58-44
• “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 58-82
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External Mode Simulation by Using XCP Communication
In an external mode simulation, you can tune parameters in real time and monitor target application
signals. Using the Run on Custom Hardware app, you can set up and run on your development
computer or custom hardware external mode simulations that use an XCP communication channel.

For an external mode simulation, you:

1 Build the target application on your development computer.
2 Deploy the target application to the target hardware.
3 Connect Simulink to the target application that runs on the target hardware.
4 Start execution of generated code on the target hardware.

Run XCP External Mode Simulation on Development Computer
Configure and run an external mode simulation that uses the XCP communication protocol. During
the simulation:

• Monitor a signal by using a Scope block, a Dashboard block, and the Simulation Data Inspector.
• Tune a parameter by using a Dashboard block.

Configure Signal Monitoring and Parameter Tuning for XCP

1 Create a folder for this example.

mkdir ext_mode_xcp_example
cd ext_mode_xcp_example

2 Open Simulink and create a simple model, xcpExample, which contains these blocks:

• Sine Wave
• Gain
• Scope
• Half Gauge
• Knob

3 Double-click the Sine Wave block. Set Sample time to 0.1, and then click OK.
4 Double-click the Gain block. Set Gain to 2, and then click OK.
5 Connect the Sine Wave block to the Gain block and name the connection, for example, Test

Signal.
6 Connect the Gain block to the Scope block and name the connection, for example, Output

Signal.
7 Configure Test Signal for logging:

a Select Test Signal.
b On the Signal tab, in the Monitor section, select Log Signals.

If you do not enable signal logging, you cannot stream Test Signal to the Simulation Data
Inspector.

8 Configure the Half Gauge block to monitor the value of Test Signal:
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a Double-click the Half Gauge block.
b In the Simulink Editor, select Test Signal.
c In the Block Parameters dialog box:

• Connect the block to Test Signal.
• In the Maximum field, enter a value, for example, 1.

d Click OK.
9 Configure the Knob block to tune the Amplitude parameter of the Sine Wave block:

a Double-click the Knob block.
b In the Simulink Editor, select the Sine Wave block.
c In the Block Parameters dialog box:

• Connect the block to the Amplitude parameter of the Sine Wave block.
• In the Minimum and Maximum fields, enter values, for example, 0.1 and 1 respectively.

d Click OK.
10 Save the model as xcpExample.

Specify Hardware and Prepare Model

1 From the Apps tab on the Simulink toolstrip, in the Setup to Run on Hardware section, click
Run on Custom Hardware. On the Run on Custom Hardware pop-up dialog box, click Finish.

2 In the Hardware section, specify the system target file. For this example, use the default,
grt.tlc. If you have Embedded Coder, you can specify ert.tlc.

3 In the Prepare gallery, under Model Configuration, click Hardware Settings. The
Configuration Parameters dialog box opens, displaying Hardware Implementation settings that
are determined by the system target file.

4 On the Solver pane:

a In the Type field, specify Fixed-step.
b Under Solver details, in the Fixed-step size field, specify a value, for example, 0.1.
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5 On the Code Generation > Optimization pane, set Default parameter behavior to Tunable.
6 On the Code Generation > Interface pane, select the External mode check box.
7 Set Transport layer to XCP on TCP/IP, which specifies ext_xcp for MEX-file name.
8 You cannot disable the Static memory allocation check box. The Static memory buffer size

value specifies the size of XCP slave memory that is allocated for signal logging. For this
example, use the default value.

9 If System target file is ert.tlc, on the Code Generation > Templates pane:

• Select the Generate an example main program check box.
• Set Target operating system to BareBoardExample.

Using the documented APIs of the external mode abstraction layer that are available in
matlabroot\toolbox\coder\xcp\src\target\ext_mode\include\ext_mode.h, the
code generator creates an example that shows how you can provide XCP external mode target
connectivity for a bare board that does not run an operating system.

10 Click OK. Then save the model.

Build and Run Target Application

In the Run on Hardware section:

1 To specify a nondefault value for the simulation stop time, in the Stop Time field, specify your
value, for example, inf.

2

Click . The software:

a Builds the target application:

• In Windows, the build process creates:

• xcpExample.exe –– The executable file.
• xcpExample.pdb –– A debugging symbols file for signals and parameters.

• In Linux, the build process places DWARF format debugging information in the created
ELF executable file, xcpExample.

b Runs the target application as separate process on your development computer.
c Connects Simulink to the target application.
d Runs the generated model code.

To perform the steps separately, click Monitor & Tune. Under Step By Step Commands, click:

a

Build for Monitoring 
b

Deploy 
c

Connect 
d

Start 
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Monitor Signal and Tune Parameter

You can monitor Test Signal through the:

• Scope block –– Double-click the block.
• Simulation Data Inspector –– Click the Simulation Data Inspector button. When the Simulation

Data Inspector opens, select the Test Signal check box, which displays streamed data.
• Half-Gauge block.

To change the amplitude of the sine wave, rotate the pointer on the Knob block to the required value.

This table describes more ways of tuning tunable block parameters during a simulation.

Approach Details
Model Data Editor To tune parameters through the Model Data

Editor:

1 On the Hardware tab of the Simulink Editor,
in the Prepare section, click Tune
Parameters, which opens the Model Data
Editor.

2 If you want to update multiple tunable
parameters simultaneously, in the Prepare
section, click Batch Mode.

3 On the Parameters tab of the Model Data
Editor, in the Value column, specify new
values for your tunable parameters.

4 If Batch Mode is selected, click Update All
Parameters or press Ctrl+D. Simulink
downloads the new values to the target
application simultaneously.

If Batch Mode is not selected, then
immediately after you specify a new value,
Simulink downloads the new value to the
target application.

For more information, see “Configure Data
Properties by Using the Model Data Editor”.
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Approach Details
Block Parameter dialog box To tune parameters through the Block Parameter

dialog box:

1 For each block that you want to update:

a Double-click the block, which opens the
Block Parameter dialog box.

b In the parameter fields, specify new
parameter values.

c Click Apply or OK.
2 If Batch Mode is selected, click Update All

Parameters or press Ctrl+D. Simulink
downloads the new values to the target
application simultaneously.

If Batch Mode is not selected, then
immediately after you click Apply or OK,
Simulink downloads the new block values to
the target application.

MATLAB workspace If block parameters are MATLAB workspace
variables:

1 In the Command Window, assign new values
to the variables.

2 On the Hardware tab of the Simulink Editor,
in the Prepare section, click Update All
Parameters (Ctrl+D). Simulink downloads
the new values to the target application.

For more information, see “Create and Edit
Variables”.

For more information about parameter tuning with generated code, see “External Mode Simulation
with TCP/IP or Serial Communication” on page 58-44 and “Create Tunable Calibration Parameter in
the Generated Code” on page 34-109.

If your model contains a Stateflow chart, you can view state activity. For more information, see
“Animate Stateflow Charts” (Stateflow).

Stop Target Application

To stop the execution of generated model code before StopTime is reached and disconnect the target

application, on the Simulink Editor toolbar, click the Stop button .

If you want to disconnect the target application from Simulink without stopping code execution, click
. Then, under Step By Step Commands, click Disconnect.
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Triggered Signal Monitoring for XCP External Mode Simulations
For XCP external mode simulations, you can configure a trigger that starts the uploading of target
application data for signal monitoring in Simulink.

1 Create a simple model in a local folder.

In the Command Window, enter these commands:
% Create work folder
if mkdir('workFolder')
    rmdir 'workFolder' s
    mkdir('workFolder')
end
cd workFolder
open_system(new_system('myModel'));

% Add, configure, and connect blocks
add_block('simulink/Sources/Sine Wave','myModel/Signal',...
                                       'Bias','5',...
                                       'Amplitude','2',...
                                       'SampleTime','0.01');
set_param('myModel/Signal','position',[140,80,180,120]);

add_block('simulink/Math Operations/Gain','myModel/Signal Gain',...
                                       'Gain','2');
set_param('myModel/Signal Gain','position',[340,80,380,120]);
add_line('myModel','Signal/1','Signal Gain/1');

% Label signal
signal=get_param('myModel/Signal','PortHandles');
set_param(signal.Outport(1),'Name','test_signal');

% And so on
add_block('simulink/Math Operations/Product','myModel/Product');
set_param('myModel/Product','position',[540,160,580,200]);
add_line('myModel','Signal Gain/1','Product/1');

add_block('simulink/Sources/Sine Wave','myModel/Carrier',...
                                       'Bias','5',...
                                       'Amplitude','10',...
                                       'Frequency','3',...
                                       'SampleTime','0.02');

set_param('myModel/Carrier','position',[140,240,180,280]);

add_block('simulink/Math Operations/Gain','myModel/Carrier Gain');
set_param('myModel/Carrier Gain','position',[340,240,380,280]);
add_line('myModel','Carrier/1','Carrier Gain/1');

signal=get_param('myModel/Carrier','PortHandles');
set_param(signal.Outport(1),'Name','test_carrier');

add_block('simulink/Signal Attributes/Rate Transition',...
          'myModel/Rate Transition');
set_param('myModel/Rate Transition','position',[440,200,480,240]);
add_line('myModel','Carrier Gain/1','Rate Transition/1');
add_line('myModel','Rate Transition/1','Product/2');

add_block('simulink/Sources/Constant','myModel/Constant',...
          'Value','0');
set_param('myModel/Constant','position',[340,320,380,360]);

add_block('simulink/Logic and Bit Operations/Relational Operator',...
          'myModel/Relational Operator','Operator','>=');
set_param('myModel/Relational Operator','position',[540,300,580,340]);
add_line('myModel','Carrier Gain/1','Relational Operator/1');
add_line('myModel','Constant/1','Relational Operator/2');

signal=get_param('myModel/Carrier Gain','PortHandles');
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set_param(signal.Outport(1),'Name','pos_carrier');

add_block('simulink/Sinks/Scope','myModel/ScopeA');
set_param('myModel/ScopeA','position',[740,160,780,200]);
add_line('myModel','Product/1','ScopeA/1');

signal=get_param('myModel/Product','PortHandles');
set_param(signal.Outport(1),'Name','test_output');

add_block('simulink/Sinks/Scope','myModel/ScopeB');
set_param('myModel/ScopeB','position',[740,300,780,340]);
add_line('myModel','Relational Operator/1','ScopeB/1');

signal=get_param('myModel/Relational Operator','PortHandles');
set_param(signal.Outport(1),'Name','cmp_output');

% Finally, save the model
save_system('myModel');

2 In the Simulink Editor, configure these signals for logging by right-clicking each signal and then
selecting Log Selected Signals:

• test_signal
• test_carrier
• test_output
• cmp_output

3 From the Apps tab on the Simulink toolstrip, in the Setup to Run on Hardware section, click
Run on Custom Hardware. On the Run on Custom Hardware pop-up dialog box, click Finish.

4 In the Prepare gallery, under Model Configuration, click Hardware Settings.
5 On the Solver pane, in the Type field, specify Fixed-step.
6 On the Code Generation > Interface pane, select the External mode check box.
7 Set Transport layer to XCP on TCP/IP, which specifies ext_xcp for MEX-file name.
8 Click OK. Then save the model.
9 To open the External Signal & Triggering dialog box, from the Prepare gallery, under Signal

Monitoring & Tracing, click Control Panel.
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10 In the Configuration section, click Signal & Triggering, which opens the External Signal &
Triggering dialog box.

Through this dialog box, you can select signals for monitoring and configure the trigger for
uploading data from the target application. For this example, use the default settings. For
example:

• The Select all check box is selected — The dialog box displays an X in each row of the
Selected column. You can monitor all logged signals during the simulation.

• Source is set to manual –– The External Mode Control Panel provides manual control of data
uploading, for example, the Arm Trigger button.

• The Arm when connecting to target check box is selected — When you connect Simulink to
the target application, the trigger is armed.

11 Click OK.
12 From the Hardware tab in the Simulink Editor, in the Run on Hardware section:

a In the Stop Time field, specify your value, for example, inf.
b Save the model.
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c

Click . The software:

i Builds the target application:
ii Runs the target application as separate process on your development computer.
iii Connects Simulink to the target application.
iv Runs the generated model code.

To view the scope displays, double-click ScopeA and ScopeB.

To monitor signals in the Simulation Data Inspector, in the Review Results section, click the Data
Inspector button.

From the External Mode Control Panel, you can suspend or resume signal logging and monitoring. In
the Connection and triggering section, click Cancel Trigger or Arm Trigger respectively.

To stop the execution of the target application and disconnect Simulink from the target environment,
click Stop Real-Time Code.

For information about signal monitoring and trigger options, see “XCP External Mode Control Panel”
on page 58-22 and “XCP External Signal & Triggering Dialog Box” on page 58-23.

Run XCP External Mode Simulation From Command Line
You can use commands to run XCP external mode simulations. To retrieve and set the values of model
parameters, use the get_param and set_param commands.

To run these commands, you must have a Simulink model open and a target application running.

1 Set the model simulation mode to external mode.

set_param(gcs,'SimulationMode','external');
2 Connect Simulink to the target application.

set_param(gcs,'SimulationCommand','connect')
3 Run generated model code.

set_param(gcs,'SimulationCommand','start');
4 To tune a parameter, change its workspace variable value through a line command. For example,

if a block parameter value is specified as a Simulink.Parameter object, assign the new value
to the Value property.

myParamObj.Value = 5.23;
5 To download the new value to the target application, update the model.

set_param(gcs,'SimulationCommand','update');
6 Stop the target application and disconnect Simulink from the target environment.

set_param(gcs,'SimulationCommand','stop');

To disconnect Simulink from the target application without stopping execution of generated code,
use this command:
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set_param(gcs,'SimulationCommand','disconnect');

The set_param commands that use the 'SimulationCommand' argument are asynchronous. If you
run the commands successively from a script, each command starts without waiting for the previous
command to complete. To check that each command is complete, in the script, use the get_param
command with the 'SimulationStatus' argument. For example, for steps 1 to 3, specify these
commands in the script:

set_param(gcs,'SimulationMode','external');
set_param(gcs,'SimulationCommand','connect');

isExternalSimulationActive = false;
while ~isExternalSimulationActive
    simStatus = get_param(gcs, 'SimulationStatus');
    isExternalSimulationActive = strcmp(simStatus, 'external');
end
set_param(gcs,'SimulationCommand','start');

For more information, see “Run Simulations Programmatically”.

The Diagnostic Viewer displays error messages produced by the get_param and set_param
commands.

Target Application Arguments
You can run your target application with optional arguments. You can pass the optional arguments to
your target application through your custom launcher implementation.

Argument Description
-w Specify that the target application enters and stays in a wait state until it

receives a message from Simulink.

If you do not specify -w, the target application executes model code
immediately. The model code runs with parameter values from the time
when you built the model.

-tf time Override the model parameter StopTime.

Specify time in:

• Seconds if PurelyIntegerCode is set to 'off'.
• Base rate steps if PurelyIntegerCode is set to 'on'.

-tf inf specifies that the model runs indefinitely when model code is
executed.

For host-based external mode simulations, you can specify additional rtiostream on page 80-
43 arguments.
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Argument Description
-verbose level Specify verbosity level:

• 0 –– No information

• 1 –– Detailed information
-port number For XCP on TCP/IP transport layer, specify the

port number of the TCP/IP server. Use an integer
value between 256 and 65535. Default is 17725.

For XCP on Serial transport layer, specify the
serial port ID. For example:

On Windows, 'COM1' or 1 for COM1, 'COM2' or 2
for COM2, and so on.

On Linux, '/dev/ttyS0', and so on.
-baud value For XCP on Serial transport layer, specify the

baud value: 1200, 2400, 4800, 9600, 14400,
19200, 38400, 57600 (default), or 115200.

XCP External Mode Limitations
This table describes limitations that apply to external mode simulations that use XCP communication.
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Feature Details
Parameter updates that change model
structure

You cannot change:

• The number of states, inputs, or outputs of a block
• The sample time or the number of sample times
• The integration algorithm for continuous systems
• The name of the model or of a block

If you make parameter updates that change the model
structure, you must rebuild the target application.

You can change numerator and denominator polynomial
parameters for the Transfer Fcn, Discrete Transfer Fcn, and
Discrete Filter blocks if the number of states does not
change.

You cannot change zero entries in the State-Space, Zero-
Pole, and Discrete Zero-Pole blocks in the user-specified or
computed parameters, that is, the A, B, C, and D matrices
obtained by a zero-pole to state-space transformation.

In the State-Space block, if you specify the matrices in the
controllable canonical realization, then changes to the A, B,
C, and D matrices that preserve this realization and the
dimensions of the matrices are allowed.

If the Simulink block diagram does not match the target
application, Simulink produces an error stating that the
checksums do not match. The checksums take into account
the top models, but not referenced models. To rebuild the
target application, use the updated block diagram.

Signal value display The graphical display of signal values during a simulation is
not supported. For example, you cannot use the Data
Display in Simulation menu items Show Value Labels
When Hovering, Toggle Value Labels When Clicked,
and Show Value Label of Selected Port. For more
information, see “Display Signal Values in Model
Diagrams”.

Data archiving Data Archiving features available on the External Mode
Control Panel are not supported. You can use the
Simulation Data Inspector to collect and export data.

Overriding signal logging settings If you use the Signal Logging Selector to override signal
logging settings, the controls to override the Decimation
and Limit data points settings are not supported.

Compiler debug symbol format Your toolchain must generate debug information in one of
these formats:

• DWARF
• PDB
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Feature Details
Inlined parameters If you set DefaultParameterBehavior to 'Inlined',

the code generator embeds numeric model parameter
values instead of symbolic parameter names in the
generated code. You can use Simulink.Parameter
objects to remove remove parameters from inlining and
declare the parameters tunable. However, when you
connect Simulink to the target application, the numeric
values of the tunable parameters are not automatically
uploaded to the model. Simulink produces a warning.

Global variables Signals, parameters, and states must be specified as global
variables. The target memory locations where the variables
are stored must lie in the range 0 – 4294967295.

Parameter structures You cannot tune parameters that are structures.
Pure integer code Pure integer code is supported. For code generation, if

PurelyIntegerCode is 'on', specify FixedStep with a
resolution that is greater or equal to 1 microsecond. For
example, specify 1.000001, but not 1.0000001.

If you do not specify -tf finalTime in the execution
command, the target application runs the generated model
code indefinitely, ignoring StopTime.

If you specify -tf finalTime in the execution command:

• The finalTime value represents base rate steps, not
seconds.

• The maximum value for finalTime, in ticks, is
MAX_int32_T.

Variable-size signals Uploading of variable-size signals is not supported.
Compiler support lcc-win64 is not supported.
Address granularity Target hardware that uses word addresses is not supported.
Portable word sizes When the production target hardware is word-addressable,

the generation of a host-based target application by using
portable word sizes is not supported. The production target
hardware must support 8-bit, 16-bit, and 32-bit native data
types.

Scope and Floating Scope blocks, and
Scope Viewer

Some signal data types are not supported. The simulation
produces a warning.

Floating Scope blocks and Scope
Viewer

You cannot use Floating Scope blocks and Scope Viewers to
monitor signals in referenced models during external mode
simulations. To monitor referenced model signals, enable
signal logging and use the Simulation Data Inspector.

Scopes in referenced models In a model hierarchy, if the top model runs in external
mode, scopes in the referenced models are not displayed.
To monitor signals within a referenced model, enable signal
logging and use the Simulation Data Inspector.
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Feature Details
Nonzero simulation start time Nonzero simulation start times are not supported. Use the

default value for Solver > Start time, 0.0.
Intermediate step values Some Simulink blocks can generate multiple values in a

simulation time step. For example:

• A Simulink Function or Function-Call Subsystem block
that is invoked multiple times in a time step.

• Iterator subsystem blocks that execute multiple times in
a time step.

For each time step in an external mode simulation, Simulink
uploads from the target application only the final values of
such blocks. Simulink does not upload the intermediate
values generated during the step.

File-scoped data File-scoped data is not supported. For example, data items
to which you apply the built-in custom storage class
FileScope. The simulation produces a warning.

For more information about the FileScope storage class,
see “Choose Storage Class for Controlling Data
Representation in Generated Code” on page 34-74.

Row-major code generation Code generated with the row-major format is not
supported.

Concurrent execution Concurrent execution is not supported. If System target
file is ert.tlc and Target operating system is
NativeThreadsExample, you cannot build the target
application.

VxWorks example If System target file is ert.tlc and Target operating
system is VxWorksExample, you cannot build the target
application.

Saving simulation output as a single
object

Saving the XCP external mode simulation output as a single
object is not supported. The simulation produces a warning.

See Also

More About
• “External Mode Simulations for Parameter Tuning and Signal Monitoring” on page 58-2
• “Configure a Signal for Logging”
• “Customize XCP Slave Software” on page 58-35
• Simulation Data Inspector

External Websites
• https://www.asam.net/standards/detail/mcd-1-xcp/wiki/
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Graphical Controls for XCP External Mode Simulations

In this section...
“Equivalent Controls on Hardware Tab and External Mode Control Panel” on page 58-21
“XCP External Mode Control Panel” on page 58-22
“XCP External Signal & Triggering Dialog Box” on page 58-23

You can control an XCP external mode simulation through:

• The Hardware tab on the Simulink Editor toolbar. To display the Hardware tab, from the Apps
tab on the Simulink toolstrip, click Run on Custom Hardware.

• The External Mode Control Panel. To open this dialog box, on the Hardware tab, in the Prepare
section, click . Then, under Signal Monitoring & Tracing, click Control Panel.

Equivalent Controls on Hardware Tab and External Mode Control Panel
This table lists external mode actions that you can perform by using controls that are available in the
Hardware tab and the External Mode Control Panel.

External Mode Action Hardware Tab External Mode Control Panel
Build target application. Run on Hardware > Build for

Monitoring 

N/A

Run application on target
hardware.

Run on Hardware > Deploy N/A

Connect Simulink to a waiting or
running target application.

Run on Hardware > Connect Connect

Start real-time execution of
generated code in the target
environment.

Run on Hardware > Start 
Start Real-Time Code

Disconnect Simulink from the
target environment, but do not
stop real-time execution of code.

Run on Hardware >

Disconnect 

Disconnect

Stop target application execution
and disconnect Simulink from the
target environment.

If you want to reestablish the
external mode connection after
stopping the target application,
you must perform the Deploy
step.

In Run on Hardware section,

Stop button .

Stop Real-Time Code
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External Mode Action Hardware Tab External Mode Control Panel
Tune batch of block parameters.
You can modify values of tunable
parameters in Simulink, and then
update the parameters in the
target application simultaneously.
See “Monitor Signal and Tune
Parameter”.

In Prepare section, Batch Mode
 and Update All Parameters

 buttons.

Batch download and Download

XCP External Mode Control Panel
The External Mode Control Panel provides these controls for XCP external mode simulations.

Section Control Description
Connection
and triggering

Connect Connect Simulink to a waiting or running target application.

When Simulink is connected to the target application,
Connect changes to Disconnect.

Start Real-Time
Code

Start real-time execution of generated code in the target
environment.

When the generated code starts executing, the button changes
to Stop Real-Time Code.

Arm Trigger Arm the trigger that you specify through the External Signal &
Triggering dialog box. If Simulink is not connected to the
target application, the button appears dimmed.

If Simulink is connected to the target application and the
trigger is armed, the button becomes Cancel Trigger.

Cancel Trigger Disarm the trigger. Once the trigger is disarmed, the button
changes to Arm Trigger.

Floating scope Enable data
uploading

Selecting the check box arms the trigger for uploading target
application data to Floating Scope blocks.

Duration Not supported.
Parameter
tuning

Batch download To tune a batch of block parameters:

1 In the External Mode Control Panel, select Batch
download.

2 In the Simulink Editor, modify the required block
parameters.

3 When you modify parameters, the External Mode Control
Panel displays this message next to Download:

Parameter changes pending... 

Simulink stores the modified parameters locally.
4 Click Download. Simulink downloads the batch of

modified parameters to the target application.
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Section Control Description
Download If the Batch download check box is not selected, the button

appears dimmed.
Configuration Signal &

Triggering
Open the External Signal & Triggering dialog box.

Data Archiving XCP external mode simulations do not support this button,
which appears dimmed.

XCP External Signal & Triggering Dialog Box
For an XCP external mode simulation, you can use the External Signal & Triggering dialog box to:

• Specify the logged signals that you want to monitor.
• Configure a trigger that starts the uploading of data from the target application.

The External Signal & Triggering dialog box provides these controls.

Section Control Description
Signal selection Select all The Signal selection view lists

top-model and referenced-model
signals that are configured for
logging. Simulink uploads a
logged signal for monitoring
only if the signal is selected in
the Signal selection view. By
default, this check box is
selected, which enables
monitoring of all logged signals.

Clear all Deselect the signals that are
selected for monitoring. If the
Select all check box is selected,
this button appears dimmed.

on, off If you select a row, clicking on
selects the corresponding signal
for monitoring. The Selected
column displays the letter X.
Clicking off deselects the signal.
If the Select all check box is
selected, these radio buttons
appear dimmed.
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Section Control Description
Trigger Signal If you select a row, clicking this

button sets the corresponding
signal as the trigger for
uploading target application
data. The Trigger column
displays the letter T. If the
signal is already selected,
clicking this button deselects
the signal.

If the configuration parameter
PurelyIntegerCode is set to
'on', the trigger signal must be
a non-complex, int32 scalar.

If the configuration parameter
PurelyIntegerCode is set to
'off', the trigger signal must
be a non-complex, double
scalar.

Go To Signal To locate a signal in the model,
select the corresponding row in
the Signal selection view and
then click this button.

Trigger options Source Specify how the trigger is
armed:

• manual (default) — Arm the
trigger by selecting the Arm
when connecting to target
check box or by clicking the
Arm Trigger button on the
External Mode Control
Panel.

• signal — Use specific
characteristics of the trigger
signal to start uploading
data.
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Section Control Description
Mode Specify trigger rearming after a

trigger event is complete:

• normal (default) — The
external mode simulation
rearms the trigger after each
trigger event.

• one-shot— The external
mode simulation collects
only one buffer of data for
each time that you arm the
trigger.

Duration Specify the number of base rate
steps for which the external
mode simulation uploads data
after a trigger event (default is
1000). For example, if Duration
is set to 1000, and the base
(fastest) rate of the model is one
second:

• For a signal sampled at the
base rate, one second (1.0
Hz), the external mode
simulation collects 1000
contiguous samples during a
trigger event.

• For a signal sampled at two
seconds (0.5 Hz), the
external mode simulation
collects 500 samples during
a trigger event.

Delay Apply a delay to data collection,
which is the time between a
trigger event and the start of
data collection expressed in
base rate steps. You can specify
a positive value or zero
(default).

An XCP external mode
simulation does not support a
negative delay (pretriggering).
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Section Control Description
Arm when connecting to
target

This check box is selected by
default. Connecting Simulink to
the target application arms the
trigger.

• If the trigger Source is
manual, data uploading
begins immediately.

• If the trigger Source is
signal, monitoring of the
trigger signal begins
immediately. Data uploading
begins when the trigger
signal satisfies trigger
conditions (as defined in the
Trigger signal section).

If you clear the check box, you
can arm the trigger by clicking
the Arm Trigger button on the
External Mode Control Panel.

Trigger signal Direction To enable the uploading of data
from the target application
when the trigger signal crosses
the threshold value (specified by
Level), specify the required
direction of the signal:

• rising (default) — Signal
must be increasing in value.

• falling — Signal must be
decreasing in value.

• either — Signal can be
increasing or decreasing in
value.

Level Specify the threshold value that
the signal must cross to start
the uploading of target
application data. Default is 0.

Hold-off Specify, in base rate steps, the
time between the termination of
one trigger event and the
rearming of the trigger. Applies
only when Mode value is
normal. Default is 0.
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See Also

More About
• “External Mode Simulation by Using XCP Communication” on page 58-7
• “Triggered Signal Monitoring for XCP External Mode Simulations” on page 58-12
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Set Up Connectivity Between Simulink and Target Hardware
For external mode simulations, you can use the target Package to provide connectivity between
Simulink and your target hardware.

This diagram gives an overview of the components of an external mode simulation.

The target package provides classes for the implementation of components. This table lists the main
classes.

Component Class Purpose
Target hardware target.Board Provide MATLAB with a

description of target hardware.
Deployment tools target.SystemCommandExec

utionTool
You can use the classes to:

• Capture system commands
for running the targettarget.ExecutionService
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Component Class Purpose
target.ExecutionTool application from your

development computer.
• Describe the execution

service implementation for
the target application.

• Provide the MATLAB service
interface for the tool that
manages the target
application execution.

To provide Monitor & Tune,
Deploy, Connect, and Start
functionality, the Run on Custom
Hardware app requires the use
of target.ExecutionTool.

Connectivity target.ExternalMode Provide communication protocol
for data transfer between
Simulink and target hardware.

target.CommunicationInte
rface

Provide target hardware with
details of the communication
channel and the rtiostream API
on page 82-14 implementation.

Customise Connectivity for XCP External Mode Simulations
For code that is generated by using ERT (ert.tlc) and GRT (grt.tlc) system target files, you can
run external mode simulations that use the XCP communication protocol:

• On your development computer.
• On other target hardware by using support packages.

If your system target file for custom target hardware is derived from the ERT or GRT system target
files, use classes from the target Package to customise connectivity. For example,
target.ExternalMode and target.CommunicationInterface.
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This example shows how you can customise connectivity for XCP-based external mode simulations. To
set up connectivity between Simulink and the target hardware:

1 Create board description

Create a target.Board object that provides MATLAB with a description of your target
hardware. To support code generation, associate the object with a processor.
processor = target.get('Processor', 'Intel-x86-64 (Windows64)');
board = target.create('Board', ...
                'Name', 'Example Intel Board', ...
                'Processors', processor);
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2 Choose deployment tool

Use one of these classes:

• target.ExecutionTool –– Provides the getApplicationStatus method, which is
required by the Run on Custom Hardware app for Monitor & Tune, Deploy, Connect, and
Start functionality.

• target.SystemCommandExecutionTool –– The getApplicationStatus method is not
available with this class. The Monitor & Tune, Deploy, Connect, and Start functionality of
the Run on Custom Hardware app is not fully supported.

In step 3 and step 4, the availability of a tool that can download the target application onto the
target hardware is assumed.

3 Using target.ExecutionTool

Implement the MATLAB service interface in a class called MyImplementationClass. For an
example pseudocode implementation, see “Execution Tool Template” on page 58-34.

classdef MyImplementationClass < target.ExecutionTool
    properties (Access=private)
    …
    end

    methods
    …
    end

    methods (Access=private)          
    …
    end
end

Create a target.ExecutionService object that contains details about executing the target
application. The object describes the tool that is required to run the target application on the
target hardware.

matlabExecution = ...
                  target.create('ExecutionService', ...
                                'Name', 'My Application Launcher');
matlabExecution.APIImplementation = ...
                  target.create('APIImplementation', ...
                                'Name', 'MyServiceImplementation');
matlabExecution.APIImplementation.BuildDependencies = ...
                  target.create('MATLABDependencies');
matlabExecution.APIImplementation.BuildDependencies.Classes = ...
                                {'MyImplementationClass'};
matlabExecution.APIImplementation.API = ...
                  target.get('API', 'ExecutionTool');

Associate the target.ExecutionService object with the target.Board object.

board.Tools.ExecutionTools = matlabExecution;
4 Using target.SystemCommandExecutionTool

Create a target.SystemCommandExecutionTool object that captures system commands for
running the target application from your development computer.
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executionTool = target.create('SystemCommandExecutionTool', ...
                'Name', 'My Execution Tool');            
executionTool.StartCommand.String = 'customDownloadTool';
executionTool.StartCommand.Arguments = {'$(EXE)'};

Associate the target.SystemCommandExecutionTool object with the target.Board object.

board.Tools.ExecutionTools = executionTool;
5 Create communication interface for target hardware

Create a target.CommunicationInterface object that provides the target hardware with
details of the communication channel and the rtiostream API on page 80-43 implementation.

For the rtiostream API, use a BuildDependencies object to specify the source files that are
compiled with the target application. This example uses the shipped TCP/IP rtiostream
implementation source file, which enables you to run external mode simulations on your
development computer. For your target hardware, provide your own rtiostream
implementation.
buildDependencies = target.create('BuildDependencies', ...
                'SourceFiles', ...
                {fullfile('$(MATLABROOT)', ...
                              'toolbox', 'coder', ...
                              'rtiostream', ...
                              'src', ...
                              'rtiostreamtcpip', ...
                              'rtiostream_tcpip.c')});

apiImplementation = target.create('APIImplementation', ...
                'Name', 'TCP x86 RTIOStream Implementation', ...
                'API', target.get('API', 'rtiostream'), ...
                'BuildDependencies', buildDependencies);

tcpComms = target.create('CommunicationInterface', ...);
                'Name', 'Windows TCP Interface', ...
                'Channel', 'TCPChannel', ...
                'APIImplementations', apiImplementation);

To specify a TCP channel, this example uses the name-value argument 'Channel',
'TCPChannel'. You can specify a serial communication channel by using the name-value
argument 'Channel', 'RS232Channel'.

Associate the target.CommunicationInterface object with the target.Board object.

board.CommunicationInterfaces = tcpComms;
6 Specify communication protocol stack

Create an object that provides the communication protocol for data transfer between Simulink
and target hardware.

a Use the target.XCPPlatformAbstraction class to utilize your custom implementation of
the XCP platform abstraction layer. The layer provides a static memory allocator and other
platform abstraction functionality.
xcpPlatformAbstraction = target.create('XCPPlatformAbstraction', ...
                'Name', 'XCP Platform Abstraction');

xcpPlatformAbstraction.BuildDependencies.Defines = {'XCP_CUSTOM_PLATFORM'};
customPlatformAbstractionPath = 'pathToImplementationFolder';
xcpPlatformAbstraction.BuildDependencies.SourceFiles = ...
                {fullfile(customPlatformAbstractionPath, 'myXCPPlatform.c')};
xcpPlatformAbstraction.BuildDependencies.IncludePaths = ...
                {customPlatformAbstractionPath};
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b Use the target.XCPTCPIPTransport class to implement the XCP transport layer, which
transmits and receives messages from the communication medium according to ASAM
specifications. In this example, the transport protocol is TCP/IP. For serial transport, replace
target.XCPTCPIPTransport with target.XCPSerialTransport.
xcpTransport = target.create('XCPTCPIPTransport', ...
                'Name', 'XCP Transport');

c Create a target.XCP object that represents the XCP protocol stack for the target hardware.
xcpConfiguration = target.create('XCP', ...
                'Name', 'XCP Configuration', ...
                'XCPTransport', xcpTransport, ...
                'XCPPlatformAbstraction', xcpPlatformAbstraction);

d Create an object that represents the XCP external mode connectivity options that are
available in the XCP protocol stack.
extModeConnectivity = ... 
             target.create('XCPExternalModeConnectivity', ...                
             'Name', 'External Mode Connectivity', ...
             'XCP', xcpConfiguration);

e Create an external mode protocol stack object.
externalMode = target.create('ExternalMode', ...
                'Name', 'External Mode', ...
                'Connectivities', extModeConnectivity);

f Add the object to the list of communication protocols that the target hardware supports.
board.CommunicationProtocolStacks = externalMode;

7 Make board object persist across MATLAB sessions

Add the board object to an internal database and make the object persist over MATLAB sessions.
target.add(board, 'UserInstall', true);

8 Select board for model

In the Configuration Parameters dialog box, set Hardware board to Example Intel Board.
9 Specify connection between Simulink and target hardware

In the Configuration Parameters dialog box:

• From the Transport layer list, select XCP on TCP/IP. The transport protocol is in the list
because of the connectivity customization.

• In the Mex-file arguments field, enter 'localhost' 1 0. For more information, see “MEX-
file arguments”.

Customize Connectivity for TCP/IP or Serial External Mode Simulations
For TCP/IP or serial external mode simulations, you can customize connectivity through a workflow
that:

• Implements transport and communication protocols.
• Specifies the execution tool for the target application by using the target Package package.

To set up connectivity between Simulink and the target hardware, use the workflow described in
“Customise Connectivity for XCP External Mode Simulations” with these differences:
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• After step 1, using the information in “Choose Communication Protocol for Client and Server” on
page 58-67 and “Create a Transport Layer for TCP/IP or Serial External Mode Communication”
on page 58-82, implement the client and server sides of external mode communication for TCP/IP
or serial protocols.

• Do not perform step 5 and step 6.

Execution Tool Template
This section provides a pseudocode example for a target.ExecutionTool service interface. The
tool starts and tracks an application on the target hardware.
classdef MyExecutionTool < target.ExecutionTool

  methods        
    function errFlag = startApplication(this)
      % Call "customDownloadTool" to download the application.
      [status, result] = ...
       system(sprintf('customDownloadTool %s', this.Application));                                     
      if status == 0
        errFlag = false;                
      else
        disp(result);
        errFlag = true;
      end
    end

    function errFlag = stopApplication(~)
      % Add code here to stop the application, if possible.
      errFlag = false;
    end

    function [status, errFlag] = getApplicationStatus(~)
      % Add code here to return the application status, if known.
      status = target.ApplicationStatus.Unknown;
      errFlag = false;
    end
  end
end

See Also
target Package

Related Examples
• “External Mode Simulations for Parameter Tuning and Signal Monitoring” on page 58-2
• “External Mode Simulation by Using XCP Communication” on page 58-7
• “Choose Communication Protocol for Client and Server” on page 58-67
• “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 58-82
• “Set Up PIL Connectivity by Using target Package” on page 80-49

External Websites
• https://www.asam.net/standards/detail/mcd-1-xcp/wiki/
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Customize XCP Slave Software
The XCP communication protocol for Simulink external mode simulations is a master-slave
communication protocol. By default, the software supports XCP external mode simulations:

• On your development computer for code that is generated by using ERT (ert.tlc) and GRT
(grt.tlc) system target files.

• For some support packages on page 58-2.

If your system target file for custom target hardware is derived from the ERT or GRT system target
files, you can use supplied APIs to provide XCP target connectivity. XCP external mode limitations on
page 58-17 apply.

The external mode target connectivity software comprises:

• External mode abstraction layer
• XCP slave protocol layer
• XCP slave transport layer
• XCP platform abstraction layer
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External Mode Abstraction Layer
To communicate with Simulink during an external mode simulation, your target application must
invoke functions from the external mode abstraction layer.

The parent folder for source code files is:

matlabroot\toolbox\coder\xcp\src\target\ext_mode

The layer APIs are declared in include\ext_mode.h and implemented in src\xcp_ext_mode.c.

To communicate with Simulink, the target application uses services exposed by the external mode
abstraction layer. This flow chart shows the required target application steps to establish
communication with Simulink.

This tables lists the functions that your target application must invoke at each stage.
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Stage Function Purpose
INITIALIZE extmodeParseArgs Extract external mode command-line

arguments.
modelName_initialize Initialize generated Simulink model

code.
extmodeInit Initialize external mode target

connectivity.
HOST START REQUEST extmodeWaitForHostRequest Wait for a start request from

development computer, which is
created when you click Run button.

RUN modelName_step Run single step of generated Simulink
model code.

extmodeEvent For sample time ID of the model,
sample signals generated by model
step function and pass packet content
to transport layer of communication
protocol for transmission to
development computer.

extmodeBackgroundRun Transmit and receive packet from
physical communication interface and
process packet content in accordance
with selected communication protocol.

HOST STOP REQUEST
OR SIMULATION
COMPLETE

extmodeStopRequested Check whether a request to stop
external mode simulation is received
from the model on the development
computer. The request is created when
you click the Stop button.

extmodeSimulationComplete Check whether execution of generated
model code is complete.

RESET modelName_terminate Terminate generated Simulink model
code.

extmodeReset Reset the external mode target
connectivity to initial state.

This pseudo-code example shows how you can implement the various flowchart stages in your target
application. During the RUN stage, the external mode run-time environment requires at least two
threads:

• A periodic thread that is responsible for the execution of the generated model code.
• A background thread that is responsible for running the external mode communication stack and

transmitting and receiving packets.

The pseudo-code simulates multithreading by running periodicThread and
extmodeBackgroundRun sequentially within the same while() loop.

/*------------- Pseudo-Code Example -------------*/
/* Define periodic thread */
void periodicThread(void)
{
  /* Run model step function */
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  modelName_step();
  /* Notify external mode abstraction layer about periodic event */
  extmodeEvent(PERIODIC_EVENT_ID, currentSimulationTime);
}

/* Main function for target application */
main(int argc, char *argv[])
{
  /*------------- INITIALIZE -------------*/
  /* Parse external mode command line arguments */
  extmodeParseArgs(argc, argv);
 
  /* Initialize model */
  modelName_initialize();
 
  /* Initialize external mode target connectivity */
  extmodeInit(extModeInfo, finalSimulationTime);

  /*------------- HOST START REQUEST -------------*/
  /* Wait until a start request is received from development computer */
  extmodeWaitForHostRequest(EXTMODE_WAIT_FOREVER);
  

  /*------- HOST STOP REQUEST OR SIMULATION COMPLETE -------*/    
  /* While simulation is not complete and stop request is not received */
  while (!extmodeSimulationComplete() && !extmodeStopRequested()) {

    /*------------- RUN -------------*/    
    periodicThread();
    extmodeBackgroundRun();
  }

  /*------------- RESET -------------*/
  /* Terminate model */
  modelName_terminate();

  /* Reset external mode target connectivity */
  extmodeReset();
  return 0;
}

To see code that invokes the functions, complete the example in “External Mode Simulation by Using
XCP Communication” on page 58-7 with System target file set to ert.tlc. Then, from the code
generation folder, open ert_main.c.

XCP Slave Protocol Layer
The XCP slave protocol layer interprets XCP commands and data according to the Association for
Standardisation of Automation and Measuring Systems (ASAM) standard, ASAM MCD-1 XCP.

The source code folder is:

matlabroot\toolbox\coder\xcp\src\target\slave\protocol\src

In an external mode simulation, the build process automatically adds the required files to the build
information object.

XCP Slave Transport Layer
The XCP slave transport layer transmits and receives messages from the communication medium
according to ASAM specifications.

The source folder is:

matlabroot\toolbox\coder\xcp\src\target\slave\transport\src
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In an external mode simulation, the build process automatically adds the required files to the build
information object.

XCP Platform Abstraction Layer
The XCP platform abstraction layer provides:

• An XCP driver on page 58-39 for sending and receiving raw data through the physical
communication interface.

• The implementation of a static memory allocator on page 58-39.
• Other target hardware-specific functionality.

For a customization example, see “Create Custom Abstraction Layer” on page 58-42.

XCP Driver

The XCP driver sends and receives XCP messages through the communication channel. In an external
mode simulation, the build process automatically adds the driver files to the build information object.

The XCP driver is based on the rtiostream API. For example, host-based external mode simulations
use these rtiostream files:

• matlabroot\toolbox\coder\rtiostream\src\rtiostreamtcpip.c
• matlabroot\toolbox\coder\rtiostream\src\rtiostream_serial.c

For details on implementing and testing an rtiostream communications channel, see:

• “Communications rtiostream API” on page 80-43
• rtiostreamtest

For a custom platform abstraction layer, you must add your rtiostream files to the build information
object. For an example, see “Create Custom Abstraction Layer” on page 58-42.

Memory Allocator

The XCP slave software requires the dynamic allocation of variable-size, contiguous memory blocks to
hold internal data structures.

In an external mode simulation, the build process automatically adds memory allocator files to the
build information object.

The xcpMemBlockSizes and xcpMemBlockCounts preprocessor macros define memory allocation.

The default memory allocator can allocate and deallocate up to 16 different sets of memory blocks.
For each set, you can override the default allocations during compilation. You can specify:

• The block size through the XCP_MEM_BLOCK_N_SIZE preprocessor macro.
• The number of blocks in each set through the XCP_MEM_BLOCK_N_NUMBER preprocessor macro.

For example, these preprocessor macros create four blocks of 64 bytes and eight blocks of 256 bytes.

#define XCP_MEM_BLOCK_1_SIZE 64
#define XCP_MEM_BLOCK_1_NUMBER 4
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#define XCP_MEM_BLOCK_2_SIZE 256
#define XCP_MEM_BLOCK_2_NUMBER 8

Configure the block sizes of the different sets in ascending order:

XCP_MEM_BLOCK_N_SIZE < XCP_MEM_BLOCK_N+1_SIZE

The smallest block size, XCP_MEM_BLOCK_1_SIZE, must be large enough to hold a pointer.

Configure alignment for the memory allocator through the XCP_MEM_ALIGNMENT preprocessor
macro. For example:

#define XCP_MEM_ALIGNMENT 8

Other Platform Abstraction Layer Functionality

This file defines the platform abstraction layer interface:
matlabroot\toolbox\coder\xcp\src\target\slave\platform\include\xcp_platform.h

To implement custom platform abstraction layer functionality, add the XCP_CUSTOM_PLATFORM
preprocessor macro to the build information object. Provide the implementation of the custom
functionality in a file named xcp_platform_custom.h. If you do not define
XCP_CUSTOM_PLATFORM, the build process uses default files that support Linux and Windows
systems.

This table describes the functionality that you must provide for the XCP slave software that you
deploy on your target hardware.

Functionality Details
Mutual exclusion To access system data structures with mutual exclusion support, the

XCP driver depends on basic APIs for definition, initialization, lock, and
unlock.

To support mutual exclusion for your target hardware, provide a custom
implementation.

The default implementation for Linux and Windows supports mutual
exclusion.
#if defined(_WIN32) || defined(__WIN32__) || defined(WIN32)
...
#define XCP_MUTEX_DEFINE(lock) HANDLE lock
#define XCP_MUTEX_INIT(lock) lock = CreateMutex(0, FALSE, 0)
#define XCP_MUTEX_LOCK(lock) WaitForSingleObject((lock), INFINITE)
#define XCP_MUTEX_UNLOCK(lock) ReleaseMutex(lock)

#else 
...
#include <pthread.h>
#define XCP_MUTEX_DEFINE(lock) pthread_mutex_t lock
#define XCP_MUTEX_INIT(lock) pthread_mutex_init(&(lock), NULL)
#define XCP_MUTEX_LOCK(lock) pthread_mutex_lock(&(lock))
#define XCP_MUTEX_UNLOCK(lock) pthread_mutex_unlock(&(lock))
...
#endif
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Functionality Details
Sleep Provide a sleep API that makes the calling thread sleep until a specified

time has elapsed. The default implementation for Linux and Windows
systems is:
#if defined(_WIN32) || defined(__WIN32__) || defined(WIN32)
...
#define XCP_SLEEP(seconds,microseconds)  Sleep((seconds) * 1000 \  
+ (((microseconds) + 1000 - 1) / 1000))

#else 
...
#if _POSIX_C_SOURCE >= 199309L
#define XCP_SLEEP(seconds,microseconds)  do {struct timespec t;\
 t.tv_sec = seconds; t.tv_nsec = microseconds * 1000; nanosleep(&t, NULL);} while(0)
#else
/* nanosleep is not available. Use select instead. */
#define XCP_SLEEP(seconds,microseconds)  do {struct timeval t; t.tv_sec = seconds;\
 t.tv_usec = microseconds; select(0, NULL, NULL, NULL, &t);} while(0)
#endif /* _POSIX_C_SOURCE >= 199309L */
...
#endif

Logging To generate diagnostic messages, the XCP slave software requires a
custom print API that supports logging services provided by the target
hardware. If you do not define the XCP_PRINTF preprocessor macro,
the default implementation is empty.

Address conversion The XCP standard expresses the address of a variable in memory as a
32-bit address with an 8-bit extension.

The XCP Master extracts the addresses of signals and parameters of the
model by parsing the debug information that the build process creates.
The debug information is in DWARF or PDB format.

The XCP Master requests access to parameters and signals by sending
an XCP command that contains the arguments addressExtension and
address.

When addressExtension and address information is received by the
target hardware, the XCP Slave must convert the address to the
location of the variable in the target hardware memory. The variable
location is assigned by the loader and is target-specific.

Use the XCP_ADDRESS_GET() macro to specify the conversion logic.
The default implementation for Linux and Windows systems is:
#if defined(__MINGW32__) || defined(__MINGW64__)
#define XCP_ADDRESS_GET(addressExtension, address) \ 
(uint8_T*) ((uintptr_t) address)
#else
#define XCP_ADDRESS_GET(addressExtension, address) \ 
(uint8_T*) ((address) + (uint8_T*)&__ImageBase)
#endif

Currently, only 32-bit hardware architectures are supported, so
addressExtension is 0.
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Functionality Details
Set and copy memory You can specify an optimized version of copy memory and set memory

operations.

If you do not define the XCP_MEMCPY and XCP_MEMSET preprocessor
macros, the default implementation specifies the standard C functions,
memcpy and memset.
#ifndef XCP_MEMCPY
#define XCP_MEMCPY memcpy
#endif

#ifndef XCP_MEMSET
#define XCP_MEMSET memset
#endif

Parsing command-line
arguments

If your target hardware does not support the parsing of command-line
arguments, define the preprocessor macro
EXTMODE_DISABLE_ARGS_PROCESSING.

To replace the -w option, you can use this command to specify that the
target application enters and stays in a wait state until it receives a
Connect message from Simulink:

set_param(modelName, 'OnTargetWaitForStart', 'on');

The build process provides the required option (-
DON_TARGET_WAIT_FOR_START=1) to the compiler.

Create Custom Abstraction Layer

For the build process, you can define a post-code generation command that creates a custom platform
abstraction layer.

1 Specify the header file xcp_platform_custom.h. This Linux example defines the required
functions.
#ifndef XCP_PLATFORM_CUSTOM_H
#define XCP_PLATFORM_CUSTOM_H

/* XCP_ADDRESS_GET */
#include <stdint.h>
#define XCP_ADDRESS_GET(addressExtension, address)  (uint8_T*) ((uintptr_t) address)

/* XCP_MUTEX */
#include <pthread.h>
#define XCP_MUTEX_DEFINE(lock)    pthread_mutex_t lock
#define XCP_MUTEX_INIT(lock)      pthread_mutex_init(&(lock), NULL)
#define XCP_MUTEX_LOCK(lock)      pthread_mutex_lock(&(lock))
#define XCP_MUTEX_UNLOCK(lock)    pthread_mutex_unlock(&(lock))

/* XCP_SLEEP */
#include <sys/time.h>    /* gettimeofday */ 
#if _POSIX_C_SOURCE >= 199309L
#include <time.h>       /* for nanosleep */
#else
#include <stddef.h>
#include <sys/select.h> /* for select */
#endif

/* _POSIX_C_SOURCE >= 199309L */
#if _POSIX_C_SOURCE >= 199309L
#define XCP_SLEEP(seconds,microseconds)  do {struct timespec t;\
 t.tv_sec = seconds; t.tv_nsec = microseconds * 1000; nanosleep(&t, NULL);} while(0)
#else
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/* nanosleep is not available. Use select instead. */
#define XCP_SLEEP(seconds,microseconds)  do {struct timeval t; t.tv_sec = seconds;\
 t.tv_usec = microseconds; select(0, NULL, NULL, NULL, &t);} while(0)
#endif /* _POSIX_C_SOURCE >= 199309L */
#endif

2 Define the post-code generation command.
function myXCPTargetPostCodeGenCommand(buildInfo)
 
  buildInfo.addDefines('-DXCP_CUSTOM_PLATFORM', 'OPTS');

  % Configure the default memory allocator
  buildInfo.addDefines('-DXCP_MEM_BLOCK_1_SIZE=64', 'OPTS');
  buildInfo.addDefines('-DXCP_MEM_BLOCK_1_NUMBER=46', 'OPTS');
  buildInfo.addDefines('-DXCP_MEM_BLOCK_2_SIZE=256', 'OPTS');
  buildInfo.addDefines('-DXCP_MEM_BLOCK_2_NUMBER=10', 'OPTS');
 
  % Add my rtiostream
  buildInfo.addSourceFiles(customRtIOStreamFileName, ...
                           customRtIOStreamSrcPath);
 
  % If the target hardware does not support parsing of command
  % line arguments
    buildInfo.addDefines('-DEXTMODE_DISABLE_ARGS_PROCESSING', 'OPTS');
 
end

See Also
extmodeBackgroundRun | extmodeEvent | extmodeGetFinalSimulationTime | extmodeInit |
extmodeParseArgs | extmodeReset | extmodeSetFinalSimulationTime |
extmodeSimulationComplete | extmodeStopRequested | extmodeWaitForHostRequest

More About
• “External Mode Simulations for Parameter Tuning and Signal Monitoring” on page 58-2
• “External Mode Simulation by Using XCP Communication” on page 58-7

External Websites
• https://www.asam.net/standards/detail/mcd-1-xcp/wiki/
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External Mode Simulation with TCP/IP or Serial Communication
Set up and run an external mode simulation that uses a TCP/IP or serial (RS-232) communication
channel.

1 Create and configure a simple model.
2 Build the target executable file.
3 Run the target application.
4 Tune parameters.

The example, which uses the GRT target, does not require external hardware. The generated
executable file runs:

• On the development computer that hosts Simulink and Simulink Coder.
• As a separate process from MATLAB and Simulink.

Create and Configure Model
In this part of the example, you create a simple model, ex_extModeExample. You also create a folder
called ext_mode_example to store the model and the generated executable.

To create the folder and the model:

1 From the MATLAB command line, type:

mkdir ext_mode_example

2 Make ext_mode_example your working folder:

cd ext_mode_example

3 Create a model in Simulink with a Sine Wave block for the input signal, two Gain blocks in
parallel, and two Scope blocks. Be sure to label the Gain and Scope blocks as shown.

4 Define and assign two MATLAB workspace variables, A and B:

A = 2;
B = 3;

5 Open Gain block A and set its Gain parameter to the variable A.
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6 Open Gain block B and set its Gain parameter to the variable B.

When the target application is built and connected to Simulink in external mode, you can
download new gain values to the executing target application. To do this, you can assign new
values to workspace variables A and B, or edit the values in the block parameters dialog box. For
more information, see “Tune Parameters” on page 58-47.

7 Verify operation of the model. Open the Scope blocks and run the model. When A = 2 and B =
3, the output appears as shown.

8 Save the model as ex_extModeExample.
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Build Target Executable
Set up the model and code generation parameters required for an external mode target application.
Then, generate code and build the target application.

1 From the Apps tab on the Simulink toolstrip, in the Setup to Run on Hardware section, click
Run on Custom Hardware.

2 In the Hardware section, from the System Target File Description list, select Generic
Real-Time Target (grt.tlc).

3 In the Prepare section, click Hardware Settings. The Configuration Parameters dialog box
opens, displaying Hardware Implementation settings that are determined by the system target
file.

4 On the Solver pane:

a In the Type field, select Fixed-step.
b In the Solver field, select discrete (no continuous states).
c Click Solver details. In the Fixed-step size field, specify 0.1. (Otherwise, when you

generate code, the Simulink Coder build process produces a warning and supplies a value.)
d Click Apply.

5 On the Data Import/Export pane, clear the Time and Output check boxes. In this example,
data is not logged to the workspace or to a MAT-file. Click Apply.

6 On the Code Generation > Optimization pane, check that Default parameter behavior is set
to Tunable. If you make a change, click Apply.

7 On the Code Generation > Interface pane, in the Data exchange interface section, select
External mode.

8 In the External mode configuration section, make sure that the default value tcpip is
selected for the Transport layer parameter.

External mode supports communication via TCP/IP, serial, and custom transport protocols. The
MEX-file name specifies the name of a MEX-file that implements host-target communication.
The default for TCP/IP is ext_comm, a MEX-file provided with the Simulink Coder software. You
can override this default by supplying other files. If you need to support other transport layers,
see “Create a Transport Layer for TCP/IP or Serial External Mode Communication”.

The MEX-file arguments field lets you specify arguments, such as a TCP/IP server port number,
to be passed to the external interface program. These arguments are specific to the external
interface that you are using. For information on setting these arguments, see “MEX-File Optional
Arguments for TCP/IP Transport” and “MEX-File Optional Arguments for Serial Transport”.

This example uses the default arguments. Leave the MEX-file arguments field blank.
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The Static memory allocation check box controls how memory is allocated for external mode
communication buffers in the target. For this example, do not select the check box. For more
information, see “Control Memory Allocation for Communication Buffers in Target” on page 58-
50.

9 Click Apply to save the external mode settings.
10 Save the model.
11 Select the Code Generation pane. Make sure that Generate code only is cleared.
12 To generate code and create the target application, in the model window, press Ctrl+B. Or, on

the Hardware tab, in the Run on Hardware section, click Monitor & Tune. Then, under Step
By Step Commands, click Build for Monitoring.

The software creates the ex_extModeExample executable file in your working folder.

Run Target Application
You now run the ex_extModeExample target executable and use Simulink as an interactive front
end to the running target application. The executable file is in your working folder. Run the target
application and establish communication between Simulink and the target.

Note An external mode program like ex_extModeExample is a host-based executable. Its execution
is not tied to a real-time operating system (RTOS) or a periodic timer interrupt, and it does not run in
real time. The program just runs as fast as possible, and the time units it counts off are simulated
time units that do not correspond to time in the world outside the program.

To run the target application:

1 On the Hardware tab, in the Run on Hardware section:

a In the Stop Time field, specify inf, which makes the model run until the target application
receives a stop message from Simulink

b Click Monitor & Tune. Then, under Step By Step Commands, click Deploy.

The target application begins execution, and enters a wait state.
2 Open the Scope blocks in the model. Signals are not visible on the scopes until you begin model

execution.
3 On the Hardware tab, in the Run on Hardware section, click Monitor & Tune. Then, under

Step By Step Commands, click Connect. This action initiates a handshake between Simulink
and the target application. When Simulink and the target are connected, the Connect button
changes to Disconnect.

4
In the Run on Hardware section, click , which starts execution of the generated model
code. The two scopes in your model display the outputs of Gain blocks A and B.

You have established communication between Simulink and the running target application. You can
now tune block parameters in Simulink and observe the effects of parameter changes.

Tune Parameters
This table describes how you can tune tunable block parameters during a simulation.
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Approach Details
Model Data Editor To tune parameters through the Model Data

Editor:

1 On the Hardware tab of the Simulink Editor,
in the Prepare section, click Tune
Parameters, which opens the Model Data
Editor.

2 If you want to update multiple tunable
parameters simultaneously, in the Prepare
section, click Batch Mode.

3 On the Parameters tab of the Model Data
Editor, in the Value column, specify new
values for your tunable parameters.

4 If Batch Mode is selected, click Update All
Parameters or press Ctrl+D. Simulink
downloads the new values to the target
application simultaneously.

If Batch Mode is not selected, then
immediately after you specify a new value,
Simulink downloads the new value to the
target application.

For more information, see “Configure Data
Properties by Using the Model Data Editor”.

Block Parameter dialog box To tune parameters through the Block Parameter
dialog box:

1 For each block that you want to update:

a Double-click the block, which opens the
Block Parameter dialog box.

b In the parameter fields, specify new
parameter values.

c Click Apply or OK.
2 If Batch Mode is selected, click Update All

Parameters or press Ctrl+D. Simulink
downloads the new values to the target
application simultaneously.

If Batch Mode is not selected, then
immediately after you click Apply or OK,
Simulink downloads the new block values to
the target application.
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Approach Details
MATLAB workspace If block parameters are MATLAB workspace

variables:

1 In the Command Window, assign new values
to the variables.

2 On the Hardware tab of the Simulink Editor,
in the Prepare section, click Update All
Parameters (Ctrl+D). Simulink downloads
the new values to the target application.

For more information, see “Create and Edit
Variables”.

You cannot change the sample time of the Sine Wave block during simulation. Block sample times are
part of the structural definition of the model and are part of the generated code. Therefore, if you
want to change a block sample time, you must stop the external mode simulation, reset the sample
time of the block, and rebuild the executable.

Block parameter tunability during external mode simulation depends on the way that the generated
code represents block parameters.

For example, in the Gain A block dialog box, you cannot change the expression A in the Gain
parameter during simulation. Instead, you must change the value of the variable A in the base
workspace. You cannot change the expression because the generated code does not allocate storage
in memory for the Gain parameter. Instead, the code creates a field A in a structure:

/* Parameters (auto storage) */
struct P_ex_extModeExample_T_ {
  real_T A;                            /* Variable: A
                                        */
  real_T B;                            /* Variable: B
                                        */
  real_T SineWave_Amp;                 /* Expression: 1
                                        */
  real_T SineWave_Bias;                /* Expression: 0
                                        */
  real_T SineWave_Freq;                /* Expression: 1
                                        */
  real_T SineWave_Phase;               /* Expression: 0
                                        */
};

The generated code algorithm uses that field in the code that represents the block Gain A. In this
case, the global structure variable ex_extModeExample_P uses the type
P_ex_extModeExample_T_:

ex_extModeExample_B.GainA = ex_extModeExample_P.A * rtb_SineWave;

When you change the value of A in the base workspace, the simulation downloads the new value to
the field A in the target application.

You can change the expressions in the Sine Wave block parameters during simulation because the
generated code creates a field in the global structure ex_extModeExample_P to represent each
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parameter in the block. When you change an expression in the block dialog box, the simulation first
evaluates the new expression. The simulation then downloads the resulting numeric value to the
corresponding structure field in the target application.

See “Create Tunable Calibration Parameter in the Generated Code” on page 34-109.

Stop Target Application
To simultaneously disconnect Simulink from the host/target communication and end execution of the
target application, on the Hardware tab, in the Run on Hardware section, click Stop.

Control Memory Allocation for Communication Buffers in Target
If you select the Code Generation > Interface > Static memory allocation check box (for GRT
and ERT targets), the code generator produces code for external mode that uses only static memory
allocation (“malloc-free” code). Selecting Static memory allocation enables the Static memory
buffer size parameter. Use this parameter to specify the size of the external mode static memory
buffer. The default value is 1,000,000 bytes. If you enter too small a value for your program, the
external mode simulation issues an out-of-memory error when it tries to allocate more memory than
specified. In such cases, increase the value in the Static memory buffer size field and regenerate
the code.

To determine how much memory to allocate, enable verbose mode on the target (by including
OPTS="-DVERBOSE" on the make command line). As it executes, external mode displays the amount
of memory it tries to allocate and the amount of memory available to it each time it attempts an
allocation. If an allocation fails, you can use this console log to determine the required value for the
Static memory buffer size field.

TCP/IP or Serial External Mode Control Panel
The External Mode Control Panel provides controls for TCP/IP or serial external mode operations,
including:

• “Connect, Start, and Stop” on page 58-51
• “Upload Target Application Signal Data to Host” on page 58-51
• “Download Parameters to Target Application” on page 58-52
• “Configure Host Monitoring of Target Application Signal Data” on page 58-53
• “Configure Host Archiving of Target Application Signal Data” on page 58-59

To open the External Mode Control Panel dialog box, on the Hardware tab, in the Prepare section,
click Control Panel.
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Connect, Start, and Stop

The External Mode Control Panel performs the same connect/disconnect and start/stop functions
found on the Hardware tab on the Simulink toolstrip (see “Summary of Graphical Controls for TCP/IP
or Serial External Mode Simulation” on page 58-61).

Clicking the Connect button connects your model to a waiting or running target application. While
you are connected, the button changes to a Disconnect button. Disconnect disconnects your model
from the target environment, but does not halt real-time code running in the target environment.

Clicking the Start Real-Time Code button commands the target to start running real-time code.
While real-time code is running in the target environment, the button changes to a Stop Real-Time
Code button. Stop Real-Time Code stops target application execution and disconnects your model
from the target environment.

Upload Target Application Signal Data to Host

The External Mode Control Panel allows you to trigger and cancel data uploads to the host. The
destination for the uploaded data can be a scope block, Display block, To Workspace block, or another
block or subsystem listed in “Blocks and Subsystems Compatible with External Mode” on page 58-
62.

The Arm Trigger and Cancel Trigger buttons provide manual control of data uploading to
compatible blocks or subsystems, except floating scopes. (For floating scopes, use the Floating
scope section of the External Mode Control Panel.)

• To trigger data uploading to compatible blocks or subsystems, click the Arm Trigger button. The
button changes to Cancel Trigger.
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• To cancel data uploading, click the Cancel Trigger button. The button reverts to Arm Trigger.

You can trigger data uploads manually or automatically. To configure signals and triggers for data
uploads, see “Configure Host Monitoring of Target Application Signal Data” on page 58-53.

A subset of external mode compatible blocks, including Scope, Time Scope, and To Workspace, allow
you to log uploaded data to disk. To configure data archiving, see “Configure Host Archiving of Target
Application Signal Data” on page 58-59.

The Floating scope section of the External Mode Control Panel controls when and for how long data
is uploaded to Floating Scope blocks. When used in external mode, floating scopes:

• Do not appear in the External Signal & Triggering dialog box.
• Do not log data to external mode archiving.
• Support manual triggering only.

The Floating scope section contains the following parameters:

• Enable data uploading option, which functions as an Arm Trigger button for floating scopes.
When the target is disconnected, the option controls whether to arm the trigger when connecting
the floating scopes. When the target is connected, the option acts as a toggle button to arm or
cancel the trigger.

• To trigger data uploading to floating scopes, select Enable data uploading.
• To cancel data uploading to floating scopes, clear Enable data uploading.

• Duration edit field, which specifies the number of base-rate steps for which external mode logs
floating scopes data after a trigger event. By default, it is set to auto, which causes the duration
value set in the External Signal & Triggering dialog box to be used. The default duration value is
1000 base rate steps.

Download Parameters to Target Application

The Batch download option on the External Mode Control Panel enables or disables batch
parameter changes.

By default, batch download is disabled. If batch download is disabled, when you click OK or Apply,
changes made directly to block parameters by editing block parameter dialog boxes are sent to the
target. When you perform an Update Diagram, changes to MATLAB workspace variables are sent.

If you select Batch download, the Download button is enabled. Until you click Download, changes
made to block parameters are stored locally. When you click Download, the changes are sent in a
single transmission.

When parameter changes are awaiting batch download, the External Mode Control Panel displays the
message Parameter changes pending... to the right of the Download button. This message
remains visible until the Simulink engine receives notification that the new parameters have been
installed in the parameter vector of the target system.

The next figure shows the External Mode Control Panel with the Batch download option activated
and parameter changes pending.
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Configure Host Monitoring of Target Application Signal Data
• “Role of Trigger in Signal Data Uploading” on page 58-53
• “Configure Signal Data Uploading” on page 58-54
• “Default Trigger Options” on page 58-55
• “Select Signals to Upload” on page 58-55
• “Configure Trigger Options” on page 58-55
• “Select Trigger Signal” on page 58-57
• “Set Trigger Conditions” on page 58-57
• “Modify Signal and Triggering Options While Connected” on page 58-58

Role of Trigger in Signal Data Uploading

In external mode, uploading target application signal data to the host depends on a trigger. The
trigger is a set of conditions that must be met for data uploading to begin. The trigger can be armed
or not armed.

• When the trigger is armed, the software checks for the trigger conditions that allow data
uploading to begin.

• If the trigger is not armed, the software does not check for the trigger conditions and data
uploading cannot begin.

• The trigger can be armed automatically, when the host connects to the target, or manually, by
clicking the Arm Trigger button on the External Mode Control Panel.
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When the trigger is armed and the trigger conditions are met, the trigger fires and data uploading
begins.

When data has been collected for a defined duration, the trigger event completes and data uploading
stops. The trigger can then rearm, or remain unarmed until you click the Arm Trigger button.

To select the target application signals to upload and configure how uploads are triggered, see
“Configure Signal Data Uploading” on page 58-54.

Configure Signal Data Uploading

Clicking the Signal & Triggering button of the External Mode Control Panel opens the External
Signal & Triggering dialog box.

The External Signal & Triggering dialog box displays a list of blocks and subsystems in your model
that support external mode signal uploading. For information on which types of blocks are external
mode compatible, see “Blocks and Subsystems Compatible with External Mode” on page 58-62.

In the External Signal & Triggering dialog box, you can select the signals that are collected from the
target system and viewed in external mode. You can also select a trigger signal, which triggers
uploading of data based on meeting certain signal conditions, and define the triggering conditions.
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Default Trigger Options

The preceding figure shows the default settings of the External Signal & Triggering dialog box. The
default operation of the External Signal & Triggering dialog box simplifies monitoring the target
application. If you use the default settings, you do not need to preconfigure signals and triggers. You
start the target application and connect the Simulink engine to it. External mode compatible blocks
are selected and the trigger is armed. Signal uploading begins immediately upon connection to the
target application.

The default configuration of trigger options is:

• Select all: on
• Source: manual
• Mode: normal
• Duration: 1000
• Delay: 0
• Arm when connecting to target: on

Select Signals to Upload

External mode compatible blocks in your model appear in the Signal selection list of the External
Signal & Triggering dialog box. You use this list to select signals that you want to view. In the
Selected column, an X appears for each selected block.

The Select all check box selects all signals. By default, Select all is selected.

If Select all is cleared, you can select or clear individual signals using the on and off options. To
select a signal, click its list entry and select the on option. To clear a signal, click its list entry and
select the off option.

The Clear all button clears all signals.

Configure Trigger Options

As described in “Role of Trigger in Signal Data Uploading” on page 58-53, signal data uploading
depends on a trigger. The trigger defines conditions that must be met for uploading to begin. Also,
the trigger must be armed for data uploading to begin. When the trigger is armed and trigger
conditions are met, the trigger fires and uploading begins. When data has been collected for a
defined duration, the trigger event completes and data uploading stops.

To control when and how signal data is collected (uploaded) from the target system, configure the
following Trigger options in the External Signal & Triggering dialog box.

• Source: manual or signal. Controls whether a button or a signal triggers data uploading.

Selecting manual directs external mode to use the Arm Trigger button on the External Mode
Control Panel as the trigger to start uploading data. When you click Arm Trigger, data uploading
begins.

Selecting signal directs external mode to use a trigger signal as the trigger to start uploading
data. When the trigger signal satisfies trigger conditions (that is, the signal crosses the trigger
level in the specified direction), a trigger event occurs. (Specify trigger conditions in the Trigger
signal section.) If the trigger is armed, external mode monitors for the occurrence of a trigger
event. When a trigger event occurs, data uploading begins.
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• Mode: normal or one-shot. Controls whether the trigger rearms after a trigger event
completes.

In normal mode, external mode automatically rearms the trigger after each trigger event. The
next data upload begins when the trigger fires.

In one-shot mode, external mode collects only one buffer of data each time you arm the trigger.

For more information on the Mode setting, see “Configure Host Archiving of Target Application
Signal Data” on page 58-59.

• Duration: Specifies the number of base rate steps for which external mode uploads data after a
trigger event (default is 1000). For example, if Duration is set to 1000, and the base (fastest) rate
of the model is one second:

• For a signal sampled at the base rate, one second (1.0 Hz), external mode collects 1000
contiguous samples during a trigger event.

• For a signal sampled at two seconds (0.5 Hz), external mode collects 500 samples during a
trigger event.

• Delay: Specifies a delay to be applied to data collection. The delay represents the amount of time
that elapses between a trigger event and the start of data collection. The delay is expressed in
base rate steps. It can be positive or negative (default is 0). A negative delay corresponds to
pretriggering. When the delay is negative, data from the time preceding the trigger event is
collected and uploaded.

• Arm when connecting to target: Selected or cleared. Whether a button or a signal triggers data
uploading (as defined by Source), the trigger must be armed to allow data uploading to begin.

If you select this option, connecting to the target arms the trigger.

• If the trigger Source is manual, data uploading begins immediately.
• If the trigger Source is signal, monitoring of the trigger signal begins immediately. Data

uploading begins when the trigger signal satisfies trigger conditions (as defined in the Trigger
signal section).

If you clear Arm when connecting to target, manually arm the trigger by clicking the Arm
Trigger button on the External Mode Control Panel.

When simulating in external mode, each rate in the model creates a buffer on the target. Each entry
in the buffer is big enough to hold all of the data required of every signal in that rate for one time
step (time plus data plus external mode indices identifying the signal). The number of entries in the
circular buffer is determined by the external mode trigger Duration parameter
(ExtModeTrigDuration). The memory allocated on the target for buffering signals is proportional
to the Duration and the number of signals uploading. The Duration also provides an indication of
the number of base rate steps with log data after a trigger event in external mode.

The Duration value specifies the number of contiguous points of data to be collected in each buffer
of data. You should enter a Duration value equal to the number of continuous sample points that you
need to collect rather than relying on a series of buffers to be continuous. If you enter a value less
than the total number of sample points, you may lose sample points during the time spent
transferring values from the data buffer to the MATLAB workspace. The Simulink software maintains
point continuity only within one buffer. Between buffers, because of transfer time, some samples may
be omitted.
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The Duration value can affect the Limit data points to last value of Scope and To Workspace
blocks. The number of sample points that the blocks save to the MATLAB workspace is the smaller of
the two values. To set the number of sample points that the blocks save, clear Limit data points to
last. Then, use Duration to specify the number of sample points saved.

Select Trigger Signal

You can designate one signal as a trigger signal. To select a trigger signal, from the Source menu in
the Trigger options section, select signal. This action enables the parameters in the Trigger
signal section. Then, select a signal in the Signal selection list, and click the Trigger Signal
button.

When you select a signal to be a trigger, a T appears in the Trigger column of the Signal selection
list. In the next figure, the Scope A signal is the trigger. Scope B is also selected for viewing, as
indicated by the X in the Selected column.

After selecting the trigger signal, you can use the Trigger signal section to define the trigger
conditions and set the trigger signal Port and Element parameters.

Set Trigger Conditions

Use the Trigger signal section of the External Signal & Triggering dialog box to set trigger
conditions and attributes. Trigger signal parameters are enabled only when the trigger parameter
Source is set to signal in the Trigger options section.
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By default, any element of the first input port of a specified trigger block can cause the trigger to fire
(that is, Port 1, any element). You can modify this behavior by adjusting the Port and Element values
in the Trigger signal section. The Port field accepts a number or the keyword last. The Element
field accepts a number or the keywords any or last.

In the Trigger signal section, you also define the conditions under which a trigger event occurs.

• Direction: rising, falling, or either. The direction in which the signal must be traveling
when it crosses the threshold value. The default is rising.

• Level: A value indicating the threshold the signal must cross in a designated direction to fire the
trigger. By default, the level is 0.

• Hold-off: Applies only to normal mode. Expressed in base rate steps, Hold-off is the time
between the termination of one trigger event and the rearming of the trigger.

Modify Signal and Triggering Options While Connected

After you configure signal data uploading, and connect Simulink to a running target executable, you
can modify signal and triggering options without disconnecting from the target.

If the trigger is armed (for example, if the trigger option Arm when connecting to the target is
selected, which is the default), the External Signal & Triggering dialog box cannot be modified. To
modify signal and triggering options:

1 Open the External Mode Control Panel.
2 Click Cancel Trigger. Triggering and display of uploaded data stops.
3 Open the External Signal & Triggering dialog box and modify signal and trigger options as

required. For example, in the Signal selection section, you can enable or disable a scope, and in
the Trigger options section, change the trigger Mode, for example, from normal to one-shot.

4 Click Arm Trigger. Triggering and display of uploaded data resumes, with your modifications.
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Configure Host Archiving of Target Application Signal Data
In external mode, you can use the Simulink Scope and To Workspace blocks to archive data to disk.

To understand how the archiving features work, consider the handling of data when archiving is not
enabled. There are two cases, one-shot mode and normal mode.

• In one-shot mode, after a trigger event occurs, each selected block writes its data to the
workspace, as it would at the end of a simulation. If another one-shot is triggered, the existing
workspace data is overwritten.

• In normal mode, external mode automatically rearms the trigger after each trigger event.
Consequently, you can think of normal mode as a series of one-shots. Each one-shot in this series,
except for the last, is referred to as an intermediate result. Because the trigger can fire at any
time, writing intermediate results to the workspace can result in unpredictable overwriting of the
workspace variables. For this reason, the default behavior is to write only the results from the
final one-shot to the workspace. The intermediate results are discarded. If you know that enough
time exists between triggers for inspection of the intermediate results, you can override the
default behavior by selecting the Write intermediate results to workspace option. This option
does not protect the workspace data from being overwritten by subsequent triggers.

If you use a Simulink Scope block to archive data to disk, open the Scope parameters dialog box and
select the option Log data to workspace. The option is required for these reasons:

• The data is first transferred from the scope data buffer to the MATLAB workspace, before being
written to a MAT-file.
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• The Variable name entered in the Scope parameters dialog box is the same as the one in the
MATLAB workspace and the MAT-file. Enabling the data to be saved enables a variable named
with the Variable name parameter to be saved to a MAT-file.

Note If you do not select the Scope block option Log data to workspace, the MAT-files for data
logging are created, but they are empty.

The Enable Data Archiving dialog box supports:

• Folder notes
• File notes
• Automated data archiving

On the External Mode Control Panel, click the Data Archiving button to open the Enable Data
Archiving dialog box. If your model is connected to the target environment, disconnect it while you
configure data archiving. To enable the other controls in the dialog box, select Enable archiving.

These operations are supported by the Enable Data Archiving dialog box.

Folder Notes

To add annotations for a collection of related data files in a folder, in the Enable Data Archiving dialog
box, click Edit Directory Note. The MATLAB editor opens. Place comments that you want saved to a
file in the specified folder in this window. By default, the comments are saved to the folder last
written to by data archiving.

File Notes

To add annotations for an individual data file, in the Enable Data Archiving dialog box, click Edit File
Note. A file finder window opens, which by default is set to the last file to which you have written.

58 Host/Target Communication in Simulink Coder

58-60



Selecting a MAT-file opens an edit window. In this window, add or edit comments that you want saved
with your individual MAT-file.

Automated Data Archiving

To configure automatic writing of logging results to disk, optionally including intermediate results,
use the Enable archiving option and the controls it enables . The dialog box provides the following
related controls:

• Directory: Specifies the folder in which data is saved. If you select Increment directory when
trigger armed, external mode appends a suffix.

• File: Specifies the name of the file in which data is saved. If you select Increment file after one-
shot, external mode appends a suffix.

• Increment directory when trigger armed: Each time that you click the Arm Trigger button,
external mode uses a different folder for writing log files. The folders are named incrementally, for
example, dirname1, dirname2, and so on.

• Increment file after one-shot: New data buffers are saved in incremental files: filename1,
filename2, and so on. File incrementing happens automatically in normal mode.

• Append file suffix to variable names: Whenever external mode increments file names, each file
contains variables with identical names. Selecting Append file suffix to variable name results in
each file containing unique variable names. For example, external mode saves a variable named
xdata in incremental files (file_1, file_2, and so on) as xdata_1, xdata_2, and so on. This
approach supports loading the MAT-files into the workspace and comparing variables at the
MATLAB command prompt. Without the unique names, each instance of xdata would overwrite
the previous one in the MATLAB workspace.

• Write intermediate results to workspace: If you want the Simulink Coder software to write
intermediate results to the workspace, select this option.

Summary of Graphical Controls for TCP/IP or Serial External Mode
Simulation
You can control a TCP/IP or serial external mode simulation through:

• The Hardware tab on the Simulink toolstrip. To display the Hardware tab, from the Apps tab on
the Simulink toolstrip, click Run on Custom Hardware.

• The External Mode Control Panel. To open this dialog box, in Simulink Editor, on the Hardware
tab, in the Prepare section, click . Then under Signal Monitoring & Tracing, click Control
Panel.

This table lists external mode actions that you can perform by using controls that are available in the
Hardware tab and the External Mode Control Panel.

External Mode Action Hardware Tab External Mode Control Panel
Build target application. Run on Hardware > Build for

Monitoring 

N/A
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External Mode Action Hardware Tab External Mode Control Panel
Run application on target
hardware.

Run on Hardware > Deploy N/A

Connect Simulink to a waiting or
running target application.

Run on Hardware > Connect

When Simulink is connected to
the target application, Connect
appears dimmed and Disconnect

 is active.

Connect

When Simulink is connected to the target
application, Connect changes to
Disconnect.

Start real-time execution of
generated code in the target
environment.

Run on Hardware > Start 
Start Real-Time Code

When the generated code starts
executing, the button changes to Stop
Real-Time Code.

Disconnect Simulink from the
target environment, but do not
stop real-time execution of code.

Run on Hardware >

Disconnect 

When Simulink is disconnected
from the target application,
Disconnect appears dimmed and

Connect  is active.

Disconnect

Stop target application execution
and disconnect Simulink from the
target environment.

In Run on Hardware section,

Stop button .

Stop Real-Time Code

Tune batch of block parameters. In Prepare section, Batch Mode
 and Update All Parameters

 buttons.

Batch download and Download

Blocks and Subsystems Compatible with External Mode
• “Compatible Blocks” on page 58-62
• “Signal Viewing Subsystems” on page 58-63
• “Supported Blocks for Data Archiving” on page 58-64

Compatible Blocks

In external mode, you can use the following types of blocks to receive and view signals uploaded from
the target application:

• Floating Scope and Scope blocks
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• Spectrum Analyzer and Time Scope blocks from the DSP System Toolbox product
• Display blocks
• To Workspace blocks
• User-written S-Function blocks

An external mode method is built into the S-function API. This method allows user-written blocks
to support external mode. See matlabroot/simulink/include/simstruc.h.

• XY Graph blocks

You can designate certain subsystems as Signal Viewing Subsystems and use them to receive and
view signals uploaded from the target application. See “Signal Viewing Subsystems” on page 58-63
for more information.

You select external mode compatible blocks and subsystems, and arm the trigger, by using the
External Signal & Triggering dialog box. By default, such blocks in a model are selected, and a
manual trigger is set to be armed when connected to the target application.

Signal Viewing Subsystems

A Signal Viewing Subsystem is an atomic subsystem that encapsulates processing and viewing of
signals received from the target system. A Signal Viewing Subsystem runs only on the host, and does
not generate code in the target system. Signal Viewing Subsystems run in normal, accelerator, rapid
accelerator, and external simulation modes.

Note Signal Viewing Subsystems are inactive if placed inside a SIL or PIL component, such as a top
model in SIL or PIL mode, a Model block in SIL or PIL mode, or a SIL or PIL block. However, a SIL or
PIL component can feed a Signal Viewing Subsystem running in a supported mode.

Signal Viewing Subsystems are useful in situations where you want to process or condition signals
before viewing or logging them, but you do not want to perform these tasks on the target system. By
using a Signal Viewing Subsystem, you can generate smaller and more efficient code on the target
system.

Like other external mode compatible blocks, Signal Viewing Subsystems are displayed in the External
Signal & Triggering dialog box.

To declare a subsystem to be a Signal Viewing Subsystem:

1 In the Block Parameters dialog box, select the Treat as atomic unit option.

For more information on atomic subsystems, see “Control Generation of Functions for
Subsystems”.

2 To turn the SimViewingDevice property on, use the set_param command:

set_param('blockname', 'SimViewingDevice','on')

'blockname' is the name of the subsystem.
3 Make sure the subsystem meets the following requirements:

• It must be a pure Sink block. That is, it must not contain Outport blocks or Data Store blocks.
It can contain Goto blocks only if the corresponding From blocks are contained within the
subsystem boundaries.
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• It must not have continuous states.

The following model, sink_examp, contains an atomic subsystem, theSink.

The subsystem theSink applies a gain and an offset to its input signal and displays it on a Scope
block.

If theSink is declared as a Signal Viewing Subsystem, the generated target application includes only
the code for the Sine Wave block. If theSink is selected and armed in the External Signal &
Triggering dialog box, the target application uploads the sine wave signal to theSink during
simulation. You can then modify the parameters of the blocks within theSink and observe the
uploaded signal.

If theSink were not declared as a Signal Viewing Subsystem, its Gain, Constant, and Sum blocks
would run as subsystem code on the target system. The Sine Wave signal would be uploaded to the
Simulink engine after being processed by these blocks, and viewed on sink_examp/theSink/
Scope2. Processing demands on the target system would be increased by the additional signal
processing, and by the downloading of changes in block parameters from the host.

Supported Blocks for Data Archiving

In external mode, you can use the following types of blocks to archive data to disk:

• Scope blocks
• To Workspace blocks

You configure data archiving by using the Enable Data Archiving dialog box, as described in
“Configure Host Archiving of Target Application Signal Data” on page 58-59.

External Mode Mechanism for Downloading Tunable Parameters
• “Download Mechanism” on page 58-65
• “Inlined and Tunable Parameters” on page 58-66

Depending on the setting of the Default parameter behavior option when the target application is
generated, there are differences in the way parameter updates are handled. “Download Mechanism”
on page 58-65 describes the operation of external mode communication with Default parameter
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behavior set to Tunable. “Inlined and Tunable Parameters” on page 58-66 describes the operation
of external mode with Default parameter behavior set to Inlined.

Download Mechanism

In external mode, the Simulink engine does not simulate the system represented by the block
diagram. By default, when external mode is enabled, the Simulink engine downloads parameters to
the target system. After the initial download, the engine remains in a waiting mode until you change
parameters in the block diagram or until the engine receives data from the target.

When you change a parameter in the block diagram, the Simulink engine calls the external interface
MEX-file, passing new parameter values (along with other information) as arguments. The external
interface MEX-file contains code that implements one side of the interprocess communication (IPC)
channel. This channel connects the Simulink process (where the MEX-file executes) to the process
that is executing the external program. The MEX-file transfers the new parameter values by using
this channel to the external program.

The other side of the communication channel is implemented within the external program. This side
writes the new parameter values into the target's parameter structure (model_P).

The Simulink side initiates the parameter download operation by sending a message containing
parameter information to the external program. In the terminology of client/server computing, the
Simulink side is the client and the external program is the server. The two processes can be remote,
or they can be local. Where the client and server are remote, a protocol such as TCP/IP is used to
transfer data. Where the client and server are local, a serial connection or shared memory can be
used to transfer data.

The next figure shows this relationship. The Simulink engine calls the external interface MEX-file
whenever you change parameters in the block diagram. The MEX-file then downloads the parameters
to the external program by using the communication channel.
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External Mode Architecture

Inlined and Tunable Parameters

By default, parameters (except those listed in “TCP/IP and Serial External Mode Limitations” on page
58-79) in an external mode program are tunable; that is, you can change them by using the
download mechanism described in this section.

If you set Default parameter behavior to Inlined (on the Optimization pane of the Configuration
Parameters dialog box), the Simulink Coder code generator embeds the numerical values of model
parameters (constants), instead of symbolic parameter names, in the generated code. Inlining
parameters generates smaller and more efficient code. However, inlined parameters, because they
effectively become constants, are not tunable.

The Simulink Coder software lets you improve overall efficiency by inlining most parameters, while at
the same time retaining the flexibility of run-time tuning for selected parameters that are important
to your application. When you inline parameters, you can use Simulink.Parameter objects to
remove individual parameters from inlining and declare them to be tunable. In addition, you can use
these objects to control how parameters are represented in the generated code.

For more information on tunable parameters, see “Create Tunable Calibration Parameter in the
Generated Code” on page 34-109.
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Automatic Parameter Uploading on Host/Target Connection

Each time the Simulink engine connects to a target application that was generated with Default
parameter behavior set to Inlined, the target application uploads the current value of its tunable
parameters to the host. These values are assigned to the corresponding MATLAB workspace
variables. This procedure synchronizes the host and target with respect to parameter values.

Workspace variables required by the model must be initialized at the time of host/target connection.
Otherwise the uploading cannot proceed and an error results. Once the connection is made, these
variables are updated to reflect the current parameter values on the target system.

Automatic parameter uploading takes place only if the target application was generated with Default
parameter behavior set to Inlined. “Download Mechanism” on page 58-65 describes the operation
of external mode communication with Default parameter behavior set to Tunable.

Choose Communication Protocol for Client and Server
• “Introduction” on page 58-67
• “Using the TCP/IP Implementation” on page 58-67
• “Using the Serial Implementation” on page 58-70
• “Run the External Program” on page 58-71
• “Implement an External Mode Protocol Layer” on page 58-73

Introduction

The Simulink Coder product provides code to implement both the client and server side of external
mode communication using either TCP/IP or serial protocols. You can use the socket-based external
mode implementation provided by the Simulink Coder product with the generated code, provided that
your target system supports TCP/IP. If not, use or customize the serial transport layer option
provided.

A low-level transport layer handles physical transmission of messages. Both the Simulink engine and
the model code are independent of this layer. Both the transport layer and code directly interfacing to
the transport layer are isolated in separate modules that format, transmit, and receive messages and
data packets.

Using the TCP/IP Implementation

You can use TCP/IP-based client/server implementation of external mode with real-time programs on
The Open Group UNIX or PC systems. For help in customizing external mode transport layers, see
“Create a Transport Layer for TCP/IP or Serial External Mode Communication”.

To use Simulink external mode over TCP/IP:

• Make sure that the external interface MEX-file for your target's TCP/IP transport is specified.

Targets provided by MathWorks specify the name of the external interface MEX-file in
matlabroot/toolbox/simulink/simulink/extmode_transports.m. The name of the
interface appears as uneditable text in the External mode configuration section of the
Interface pane of the Configuration Parameters dialog box. The TCP/IP default is ext_comm.

To specify a TCP/IP transport for a custom target, you must add an entry of the following form to
an sl_customization.m file on the MATLAB path:
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function sl_customization(cm)
  cm.ExtModeTransports.add('stf.tlc', 'transport', 'mexfile', 'Level1');
%end function

• stf.tlc is the name of the system target file for which you are registering the transport (for
example, 'mytarget.tlc')

• transport is the transport name to display in the Transport layer menu on the Interface
pane of the Configuration Parameters dialog box (for example, 'tcpip')

• mexfile is the name of the transport's associated external interface MEX-file (for example,
'ext_comm')

You can specify multiple targets and/or transports with additional cm.ExtModeTransports.add
lines, for example:
function sl_customization(cm)
  cm.ExtModeTransports.add('mytarget.tlc', 'tcpip', 'ext_comm', 'Level1');
  cm.ExtModeTransports.add('mytarget.tlc', 'serial', ...
                           'ext_serial_win32_comm', 'Level1');
%end function

• Be sure that the template makefile is configured to link the source files for the TCP/IP server code
and that it defines the compiler flags when building the generated code.

• Build the external program.
• Run the external program.
• Set the Simulink model to external mode and connect to the target.

The next figure shows the structure of the TCP/IP-based implementation.
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TCP/IP-Based Client/Server Implementation for External Mode
MEX-File Optional Arguments for TCP/IP Transport

In the External Target Interface dialog box, you can specify optional arguments that are passed to the
external mode interface MEX-file for communicating with executing targets.

• Target network name: the network name of the computer running the external program. By
default, this is the computer on which the Simulink product is running, for example,
'myComputer'. You can also use the IP address, for example, '148.27.151.12'.

• Verbosity level: controls the level of detail of the information displayed during the data transfer.
The value is either 0 or 1 and has the following meaning:

0 — No information 
1 — Detailed information

• TCP/IP server port number: The default value is 17725. You can change the port number to a
value between 256 and 65535 to avoid a port conflict.

The arguments are positional and must be specified in the following order:

<TargetNetworkName> <VerbosityLevel> <ServerPortNumber>

For example, if you want to specify the verbosity level (the second argument), then you must also
specify the target network name (the first argument). Arguments can be delimited by white space or
commas. For example:

'148.27.151.12' 1 30000

 External Mode Simulation with TCP/IP or Serial Communication

58-69



You can specify command-line options to the external program when you launch it. See “Run the
External Program” on page 58-71.

Using the Serial Implementation

Controlling host/target communication on a serial channel is similar to controlling host/target
communication on a TCP/IP channel.

To use Simulink external mode over a serial channel, you must:

• Make sure that the external interface MEX-file for your target's serial transport is specified.

Targets provided by MathWorks specify the name of the external interface MEX-file in
matlabroot/toolbox/simulink/simulink/extmode_transports.m. The name of the
interface appears as uneditable text in the External mode configuration section of the
Interface pane of the Configuration Parameters dialog box. The serial default is serial.

To specify a serial transport for a custom target, you must add an entry of the following form to an
sl_customization.m file on the MATLAB path:
function sl_customization(cm)
  cm.ExtModeTransports.add('stf.tlc', 'transport', 'mexfile', 'Level1');
%end function

• stf.tlc is the name of the system target file for which you are registering the transport (for
example, 'mytarget.tlc')

• transport is the transport name to display in the Transport layer menu on the Interface
pane of the Configuration Parameters dialog box (for example, 'serial')

• mexfile is the name of the transport's associated external interface MEX-file (for example,
'ext_serial_win32_comm')

You can specify multiple targets and/or transports with additional cm.ExtModeTransports.add
lines, for example:
function sl_customization(cm)
  cm.ExtModeTransports.add('mytarget.tlc', 'tcpip', 'ext_comm', 'Level1');
  cm.ExtModeTransports.add('mytarget.tlc', 'serial', ...
                           'ext_serial_win32_comm', 'Level1');
%end function

• Be sure that the template makefile is configured to link the source files for the serial server code
and that it defines the compiler flags when building the generated code.

• Build the external program.
• Run the external program.
• Set the Simulink model to external mode and connect to the target.

MEX-File Optional Arguments for Serial Transport

In the MEX-file arguments field of the Interface pane of the Configuration Parameters dialog box,
you can specify arguments that are passed to the external mode interface MEX-file for
communicating with the executing targets. For serial transport, the optional arguments to
ext_serial_win32_comm are as follows:

• Verbosity level: This argument controls the level of detail of the information displayed during data
transfer. The value of this argument is:
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• 0 (no information), or
• 1 (detailed information)

• Serial port ID: The port ID of the host, specified as an integer or character vector. For example,
specify the port ID of a USB to serial converter as '/dev/ttyusb0'. Simulink Coder prefixes
integer port IDs with \\.\COM on Windows and by /dev/ttyS on Unix.

When you start the target application using a serial connection, you must specify the port ID to
use to connect it to the host. Do this by including the -port command-line option. For example:

mytarget.exe -port 2 -w

• Baud rate: Specify an integer value. The default value is 57600.

The MEX-file options arguments are positional and must be specified in the following order:

<VerbosityLevel> <SerialPortID> <BaudRate>

For example, if you want to specify the serial port ID (the second argument), then you must also
specify the verbosity level (the first argument). Arguments can be delimited by white space or
commas. For example:

1 '/dev/ttyusb0' 57600

When you launch the external program, you can specify command-line options.

Run the External Program

Before you can use the Simulink product in external mode, the external program must be running.

If the target application is executing on the same machine as the host and communication is through
a loopback serial cable, the target's port ID must differ from that of the host (as specified in the MEX-
file arguments edit field).

To run the external program, you type a command of the form:

model -opt1 ... -optN

model is the name of the external program and -opt1 ... -optN are options. (See “Command-Line
Options for the External Program” on page 58-72.) In the examples in this section, the name of the
external program is ext_example.

Running the External Program in the Windows Environment

In the Windows environment, you can run the external programs in either of the following ways:

• Open a Command Prompt window. At the command prompt, type the name of the target
executable, followed by possible options, such as:

ext_example -tf inf -w

• Alternatively, you can launch the target executable from the MATLAB Command Window. The
command must be preceded by an exclamation point (!) and followed by an ampersand (&), as in
the following example:

!ext_example -tf inf -w &
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The ampersand (&) causes the operating system to spawn another process to run the target
executable. If you do not include the ampersand, the program still runs, but you cannot enter
commands at the MATLAB command prompt or manually terminate the executable.

Running the External Program in the UNIX Environment

In the UNIX environment, you can run the external programs in either of the following ways:

• Open an Xterm window. At the command prompt, type the name of the target executable, followed
by possible options, such as:

./ext_example -tf inf -w
• Alternatively, you can launch the target executable from the MATLAB Command Window. You must

run it in the background so that you can still access the Simulink environment. The command
must be preceded by an exclamation point (!), dot slash (./ indicating the current directory), and
followed by an ampersand (&), as in the following example:

!./ext_example -tf inf -w &

The ampersand (&) causes the operating system to spawn another process to run the target
executable.

Command-Line Options for the External Program

External mode target executables generated by the Simulink Coder code generator support the
following command-line options:

• -tf n

The -tf option overrides the stop time set in the Simulink model. The argument n specifies the
number of seconds the program will run. The value inf directs the model to run indefinitely. In
this case, the model code runs until the target application receives a stop message from the
Simulink engine.

The following example sets the stop time to 10 seconds.

ext_example -tf 10

When integer-only ERT targets are built and executed in external mode, the stop time parameter (-
tf) is interpreted by the target as the number of base rate steps rather than the number of seconds
to execute.

• -w

Instructs the target application to enter a wait state until it receives a message from the host. At
this point, the target is running, but not executing the model code. The start message is sent when
you select Start Real-Time Code from the Simulation menu or click the Start Real-Time Code
button in the External Mode Control Panel.

Use the -w option if you want to view target application execution data from time step 0, or if you
want to modify parameters before the target application begins execution of model code.

• -port n

Specifies the TCP/IP port number or the serial port ID, n, for the target application. The port
number of the target application must match that of the host for TCP/IP transport. The port
number depends on the type of transport.
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• For TCP/IP transport: Port number is an integer between 256 and 65535, with the default
value being 17725.

• For serial transport: Port ID is an integer or a character vector. For example, specify the port
ID of a USB to serial converter as '/dev/ttyusb0'

• -baud r

Specified as an integer, this option is only available for serial transport.

Implement an External Mode Protocol Layer

If you want to implement your own transport layer for external mode communication, you must
modify certain code modules provided by the Simulink Coder product and create a new external
interface MEX-file. See “Create a Transport Layer for TCP/IP or Serial External Mode
Communication”.

Use External Mode Programmatically
You can run external mode simulations from the MATLAB command line or programmatically in
scripts. Use the get_param and set_param commands to retrieve and set the values of model
simulation command-line parameters, such as SimulationMode and SimulationCommand, and
external mode command-line parameters, such as ExtModeCommand and ExtModeTrigType.

The following model simulation commands assume that a Simulink model is open and that you have
loaded a target application to which the model will connect using external mode.

1 Change the Simulink model to external mode:

set_param(gcs,'SimulationMode','external')
2 Connect the open model to the loaded target application:

set_param(gcs,'SimulationCommand','connect')
3 Start running the target application:

set_param(gcs,'SimulationCommand','start')
4 Stop running the target application:

set_param(gcs,'SimulationCommand','stop')
5 Disconnect the target application from the model:

set_param(gcs,'SimulationCommand','disconnect')

The set_param commands that use the 'SimulationCommand' argument are asynchronous. If you
run the commands successively from a script, each command starts without waiting for the previous
command to complete. To check that each command is complete, in the script, use the get_param
command with the 'SimulationStatus' argument. For example, for steps 1 to 3, specify these
commands in the script:

set_param(gcs,'SimulationMode','external');
set_param(gcs,'SimulationCommand','connect');

isExternalSimulationActive = false;
while ~isExternalSimulationActive
    simStatus = get_param(gcs, 'SimulationStatus');
    isExternalSimulationActive = strcmp(simStatus, 'external');

 External Mode Simulation with TCP/IP or Serial Communication

58-73



end
set_param(gcs,'SimulationCommand','start');

For more information, see “Run Simulations Programmatically”.

The Diagnostic Viewer displays error messages produced by the get_param and set_param
commands.

To tune a workspace parameter, change its value at the command prompt. If the workspace
parameter is a Simulink.Parameter object, assign the new value to the Value property.

myVariable = 5.23;
myParamObj.Value = 5.23;

To download the workspace parameter in external mode, you update the model diagram. The
following model simulation command initiates a model update:

set_param(gcs,'SimulationCommand','update')

To trigger or cancel data uploading to scopes, use the ExtModeCommand values armFloating and
cancelFloating, or armWired and cancelWired. For example, to trigger and then cancel data
uploading to wired (nonfloating) scopes:

set_param(gcs,'ExtModeCommand','armWired')
set_param(gcs,'ExtModeCommand','cancelWired')

The next table lists external mode command-line parameters that you can use in get_param and
set_param commands. The table provides brief descriptions, valid values (bold type highlights
defaults), and a mapping to External Mode dialog box equivalents. For external mode parameters that
are equivalent to Interface pane options in the Configuration Parameters dialog box, see “Model
Configuration Parameters: Code Generation Interface”.
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External Mode Command-Line Parameters

Parameter and Values Dialog Box Equivalent Description
ExtModeAddSuffixToVar
off, on

Enable Data Archiving: Append
file suffix to variable names
check box

Increment variable names for
each incremented filename.

ExtModeArchiveDirName
character vector

Enable Data Archiving:
Directory text field

Save data in specified folder.

ExtModeArchiveFileName
character vector

Enable Data Archiving: File text
field

Save data in specified file.

ExtModeArchiveMode
character vector - off, auto, manual

Enable Data Archiving: Enable
archiving check box

Activate automated data
archiving features.

To specify manual, run
set_param(gcs,
'ExtModeArchiveMode',
'manual').

Note that if you specify auto,
ExtModeAutoIncOneShot is
set to on.

ExtModeArmWhenConnect
off, on

External Signal & Triggering:
Arm when connecting to
target check box

Arm the trigger as soon as the
Simulink Coder software
connects to the target.

ExtModeAutoIncOneShot
off, on

Enable Data Archiving:
Increment file after one-shot
check box

Save new data buffers in
incremental files.

ExtModeAutoUpdateStatusClock
(Windows platforms only)
off, on

Not available Continuously upload and display
target time on the model
window status bar.

ExtModeBatchMode
off, on

External Mode Control Panel:
Batch download check box

Enable or disable downloading
of parameters in batch mode.

ExtModeChangesPending
off, on

Not available When ExtModeBatchMode is
enabled, indicates whether
parameters remain in the queue
of parameters to be downloaded
to the target.
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Parameter and Values Dialog Box Equivalent Description
ExtModeCommand
character vector - armFloating,
armWired, cancelFloating,
cancelWired

• armFloating and
cancelFloating are
equivalent to selecting and
clearing External Mode
Control Panel check box
Floating scope > Enable
data uploading

• armWired and cancelWired
are equivalent to External
Mode Control Panel buttons
Arm Trigger and Cancel
Trigger

Issue an external mode
command to the target
application.

ExtModeConnected
off, on

External Mode Control Panel:
Connect/Disconnect button

Indicate the state of the
connection with the target
application.

ExtModeEnableFloating
off, on

External Mode Control Panel:
Enable data uploading check
box

Enable or disable the arming
and canceling of triggers when
a connection is established with
floating scopes.

ExtModeIncDirWhenArm
off, on

Enable Data Archiving:
Increment directory when
trigger armed check box

Write log files to incremental
folders each time the trigger is
armed.

ExtModeLogAll
off, on

External Signal & Triggering:
Select all check box

Upload available signals from
the target to the host.

ExtModeParamChangesPending
off, on

Not available When the Simulink Coder
software is connected to the
target and ExtModeBatchMode
is enabled, indicates whether
parameters remain in the queue
of parameters to be downloaded
to the target. More efficient
than
ExtModeChangesPending,
because it checks for a
connection to the target.

ExtModeSkipDownloadWhenConnect
off, on

Not available Connect to the target
application without downloading
parameters.

ExtModeTrigDelay
integer (0)

External Signal & Triggering:
Delay text field

Specify the amount of time
(expressed in base rate steps)
that elapses between a trigger
occurrence and the start of data
collection.

ExtModeTrigDirection
character vector - rising, falling,
either

External Signal & Triggering:
Direction menu

Specify the direction in which
the signal must be traveling
when it crosses the threshold
value.
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Parameter and Values Dialog Box Equivalent Description
ExtModeTrigDuration
integer (1000)

External Signal & Triggering:
Duration text field

Specify the number of base rate
steps for which external mode is
to log data after a trigger event.

ExtModeTrigDurationFloating
character vector - integer (auto)

External Mode Control Panel:
Duration text field

Specify the duration for floating
scopes. If auto is specified, the
value of
ExtModeTrigDuration is
used.

ExtModeTrigElement
character vector - integer, any, last

External Signal & Triggering:
Element text field

Specify the elements of the
input port of the specified
trigger block that can cause the
trigger to fire.

ExtModeTrigHoldOff
integer (0)

External Signal & Triggering:
Hold-off text field

Specify the base rate steps
between when a trigger event
terminates and the trigger is
rearmed.

ExtModeTrigLevel
integer (0)

External Signal & Triggering:
Level text field

Specify the threshold value the
trigger signal must cross to fire
the trigger.

ExtModeTrigMode
character vector - normal, oneshot

External Signal & Triggering:
Mode menu

Specify whether the trigger is to
rearm automatically after each
trigger event or whether only
one buffer of data is to be
collected each time the trigger
is armed.

ExtModeTrigPort
character vector - integer (1), last

External Signal & Triggering:
Port text field

Specify the input port of the
specified trigger block for which
elements can cause the trigger
to fire.

ExtModeTrigType
character vector - manual, signal

External Signal & Triggering:
Source menu

Specify whether to start logging
data when the trigger is armed
or when a specified trigger
signal satisfies trigger
conditions.

ExtModeUploadStatus
character vector - inactive, armed,
uploading

Not available Return the status of the external
mode upload mechanism —
inactive, armed, or uploading.

ExtModeWriteAllDataToWs
off, on

Enable Data Archiving: Write
intermediate results to
workspace check box

Write intermediate results to the
workspace.

Animate Stateflow Charts in External Mode
If you have Stateflow, you can animate a chart in external mode. In external mode, you can animate
states in a chart, and view test point signals in a floating scope or signal viewer.
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• “Animate States During Simulation in External Mode” on page 58-78
• “View Test Point Data in Floating Scopes and Signal Viewers” on page 58-78

Animate States During Simulation in External Mode

To animate states in a chart in external mode:

1 Load the chart you want to animate to the target machine.
2 In the Configuration Parameters dialog box, select the External mode check box.
3 Open the External Mode Control Panel dialog box.
4 Click Signal & Triggering.
5 In the External Signal & Triggering dialog box, set these parameters.

In: Select:
Signal selection pane Chart you want to animate
Trigger options pane Arm when connecting to target check box
Trigger options pane normal from drop-down menu in Mode field

6 Build the model to generate an executable file.
7 Deploy the target application.
8 Connect Simulink to the target application.
9 Start execution of the generated model code. The chart highlights states as they execute.

View Test Point Data in Floating Scopes and Signal Viewers

When you simulate a chart in external mode, you can designate chart data of local scope to be test
points and view the test point data in floating scopes and signal viewers.

To view test point data during simulation in external mode:

1 Open the Model Explorer and for each data you want to view, follow these steps:

a In the middle Contents pane, select the state or local data of interest.
b In the right Dialog pane, select the Logging tab and select Test point check box.

2 From a floating scope or signal viewer, click the signal selection button:

The Signal Selector dialog box opens.
3 In the Signal Selector Model hierarchy pane, select the chart.
4 In the Signal Selector List contents menu, select Testpointed/Logged signals only and then

select the signals you want to view.
5 Simulate the model in external mode as described in “Animate States During Simulation in

External Mode” on page 58-78.

The scope or viewer displays the values of the test point signals as the simulation runs.

For more information, see “Behavior of Scopes and Viewers with Rapid Accelerator Mode”.

58 Host/Target Communication in Simulink Coder

58-78



TCP/IP and Serial External Mode Limitations
Feature Details
Changing parameters In general, you cannot change a parameter if doing so results in a

change in the structure of the model. For example, you cannot change

• The number of states, inputs, or outputs of a block
• The sample time or the number of sample times
• The integration algorithm for continuous systems
• The name of the model or of a block

If you make these changes to the block diagram, then you must rebuild
the program with newly generated code.

You can change parameters in transfer function and state space
representation blocks in specific ways:

• The parameters (numerator and denominator polynomials) for the
Transfer Fcn (continuous and discrete) and Discrete Filter blocks
can be changed (as long as the number of states does not change).

• Zero entries in the State-Space and Zero Pole (both continuous and
discrete) blocks in the user-specified or computed parameters (that
is, the A, B, C, and D matrices obtained by a zero-pole to state-space
transformation) cannot be changed once external simulation is
started.

• In the State-Space block, if you specify the matrices in the
controllable canonical realization, then all changes to the A, B, C, D
matrices that preserve this realization and the dimensions of the
matrices are allowed.

If the Simulink block diagram does not match the external program,
Simulink produces an error stating that the checksums do not match.
The checksums take into account the top models, but not referenced
models. Use the updated block diagram to rebuild the target
application.

Uploading data Uploading of data values for fixed-point or enumerated types to
workspace parameters is not supported.

Uploading variable-size
signals

Uploading of variable-size signals is not supported for these targets:

• Simulink Real-Time
• Texas Instruments™ C2000™

Signal value display in
simulation

Graphical display of signal values in models (described in “Display
Signal Values in Model Diagrams”) is not supported. For example, you
cannot use the Data Display in Simulation menu selections Show
Value Labels When Hovering, Toggle Value Labels When Clicked,
and Show Value Label of Selected Port.

Tunable structure
parameters

Uploading or downloading of tunable structure parameters is not
supported.
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Feature Details
Pure integer code Pure integer code is supported.

If you do not specify -tf finalTime in the execution command, the
target application runs the generated model code indefinitely, ignoring
StopTime.

If you specify -tf finalTime in the execution command:

• The finalTime value represents base rate steps, not seconds.
• The maximum value for finalTime, in ticks, is MAX_int32_T.
• When the 16-bit or 32-bit tick counter overflows, the simulation time

in Scope blocks returns to zero.
Half precision Half-precision data types are not supported.
Archiving data For archiving data to disk, Scope and To Workspace blocks are

supported. However, other scopes are not supported for data archiving.
For example, you cannot use Floating Scope blocks or Viewers and
Generators Manager viewer objects to archive data.

Scopes in referenced
models

In a model hierarchy, if the top model simulates in external mode and a
referenced model simulates in normal or accelerator mode, scopes in
the referenced model are not displayed.

However, if the top model is changed to simulate in normal mode, the
behavior of scopes in the referenced models differs between normal and
accelerator mode. Scopes in a referenced model simulating in normal
mode are displayed, while scopes in a referenced model simulating in
accelerator mode are not displayed.

Simulation start time Nonzero simulation start times are not supported. In the Configuration
Parameters dialog box, Solver pane, leave Start time set to the default
value of 0.0.

Intermediate step values Some Simulink blocks can generate multiple values in a simulation time
step. For example:

• A Simulink Function or Function-Call Subsystem block that is
invoked multiple times in a time step.

• Iterator subsystem blocks that execute multiple times in a time step.

For each time step in an external mode simulation, Simulink uploads
from the target application only the final values of such blocks. Simulink
does not upload the intermediate values generated during the step.

File-scoped data File-scoped data are not supported, for example, data items to which
you apply the built-in custom storage class, FileScope. File-scoped
data are not externally accessible.

Signals with custom
storage classes

Uploading of signals with custom storage classes (CSC) is not
supported.
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Feature Details
Use of printf Statements To show target application error and information messages on the

target hardware display, you can use printf calls. For some target
hardware, the use of printf statements can increase the external
mode binary file size. To disable printf calls, specify the preprocessor
macro definition EXTMODE_DISABLEPRINTF for your target application
compiler.

Command-line arguments You can use command-line arguments for running target applications.
These limitations apply:

• Parsing of the command-line arguments requires the sscanf
function, which increases the program size for some target
hardware.

• Some target applications do not accept command-line arguments.

If your target hardware does not support the parsing of command-line
arguments, specify the preprocessor macro definition
EXTMODE_DISABLE_ARGS_PROCESSING=1 for your target application
compiler.

To replace the -w option, you can use this command to specify that the
target application enters and stays in a wait state until it receives a
Connect message from Simulink:

set_param(modelName, 'OnTargetWaitForStart', 'on');

The build process provides the required option (-
DON_TARGET_WAIT_FOR_START=1) to the compiler.

Row-major code generation Code generated with the row-major format is not supported.

See Also

More About
• “External Mode Simulation by Using XCP Communication” on page 58-7
• “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 58-82
• “Customize Connectivity for TCP/IP or Serial External Mode Simulations” on page 58-33
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Create a Transport Layer for TCP/IP or Serial External Mode
Communication

In this section...
“Design of External Mode” on page 58-82
“External Mode Communications Overview” on page 58-84
“External Mode Source Files” on page 58-85
“Implement a Custom Transport Layer” on page 58-88

This section helps you to connect your custom target by using external mode using your own low-
level communications layer. The topics include:

• An overview of the design and operation of external mode
• A description of external mode source files
• Guidelines for modifying the external mode source files and building an executable to handle the

tasks of the default ext_comm MEX-file

This section assumes that you are familiar with the execution of Simulink Coder programs, and with
the basic operation of external mode.

Design of External Mode
External mode communication between the Simulink engine and a target system is based on a client/
server architecture. The client (the Simulink engine) transmits messages requesting the server
(target) to accept parameter changes or to upload signal data. The server responds by executing the
request.

A low-level transport layer handles physical transmission of messages. Both the Simulink engine and
the model code are independent of this layer. Both the transport layer and code directly interfacing to
the transport layer are isolated in separate modules that format, transmit, and receive messages and
data packets.

This design makes it possible for different targets to use different transport layers. The GRT, ERT, and
RSim targets support host/target communication by using TCP/IP and RS-232 (serial) communication.
The Simulink Desktop Real-Time target supports shared memory communication. The Wind River
Systems Tornado® target supports TCP/IP only.

The Simulink Coder product provides full source code for both the client and server-side external
mode modules, as used by the GRT, ERT, Rapid Simulation, and Tornado targets, and the Simulink
Desktop Real-Time and Simulink Real-Time products. The main client-side module is ext_comm.c.
The main server-side module is ext_svr.c.

These two modules call the specified transport layer through the following source files.
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Built-In Transport Layer Implementations

Protocol Client or
Server?

Source Files

TCP/IP Client (host) • matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host/
common/rtiostream_interface.c

• matlabroot/toolbox/coder/rtiostream/rtiostreamtcpip/
rtiostream_tcpip.c

 Server
(target)

• matlabroot/rtw/c/src/ext_mode/common/rtiostream_interface.c
• matlabroot/toolbox/coder/rtiostream/rtiostreamtcpip/

rtiostream_tcpip.c
Serial Client (host) • matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host/

serial/ext_serial_transport.c
• matlabroot/toolbox/coder/rtiostream/src/rtiostreamserial/

rtiostream_serial.c
 Server

(target)
• matlabroot/rtw/c/src/ext_mode/serial/ext_svr_serial_transport.c
• matlabroot/toolbox/coder/rtiostream/src/rtiostreamserial/

rtiostream_serial.c

For serial communication, the modules ext_serial_transport.c and rtiostream_serial.c
implement the client-side transport functions and the modules ext_svr_serial_transport.c and
rtiostream_serial.c implement the corresponding server-side functions. For TCP/IP
communication, the modules rtiostream_interface.c and rtiostream_tcpip.c implement
both client-side and server-side functions. You can edit copies of these files (but do not modify the
originals). You can support external mode using your own low-level communications layer by creating
similar files using the following templates:

• Client (host) side: matlabroot/toolbox/coder/rtiostream/src/rtiostreamtcpip/
rtiostream_tcpip.c (TCP/IP) or matlabroot/toolbox/coder/rtiostream/src/
rtiostreamserial/rtiostream_serial.c (serial)

• Server (target) side: matlabroot/toolbox/coder/rtiostream/src/rtiostreamtcpip/
rtiostream_tcpip.c (TCP/IP) or matlabroot/toolbox/coder/rtiostream/src/
rtiostreamserial/rtiostream_serial.c (serial)

The rtiostream_interface.c file is an interface between the external mode protocol and an
rtiostream communications channel. For more details on implementing and testing an
rtiostream communications channel, see:

• “Communications rtiostream API” on page 80-43
• rtiostreamtest

Implement your rtiostream communications channel by using the documented interface to avoid
having to make changes to the file rtiostream_interface.c or other external mode related files.

Note Do not modify working source files. Use the templates provided in the /custom or /
rtiostream folder as starting points, guided by the comments within them.
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You need only provide code that implements low-level communications. You need not be concerned
with issues such as data conversions between host and target, or with the formatting of messages.
The Simulink Coder software handles these functions.

On the client (Simulink engine) side, communications are handled by ext_comm (for TCP/IP) and
ext_serial_win32_comm (for serial) MEX-files.

On the server (target) side, external mode modules are linked into the target executable. This takes
place automatically at code generation time if you select External mode and is based on the
Transport layer option that you specify. The modules, called from the main program and the model
execution engine, are independent of the generated model code.

The general procedure for implementing your own client-side low-level transport protocol is as
follows:

1 Edit the template rtiostream_tcpip.c to replace low-level communication calls with your own
communication calls.

2 Generate a MEX-file executable for your custom transport.
3 Register your new transport layer with the Simulink software, so that the transport can be

selected for a model using the Interface pane of the Configuration Parameters dialog box.

For more details, see “Create a Custom Client (Host) Transport Protocol” on page 58-88.

The general procedure for implementing your own server-side low-level transport protocol is as
follows:

1 Edit the template rtiostream_tcpip.c to replace low-level communication calls with your own
communication calls. Typically this involves writing or integrating device drivers for your target
hardware.

2 Modify template makefiles to support the new transport.

For more details, see “Create a Custom Server (Target) Transport Protocol” on page 58-91.

External Mode Communications Overview
This section gives a high-level overview of how a Simulink Coder generated program communicates
with Simulink external mode. This description is based on the TCP/IP version of external mode that
ships with the Simulink Coder product.

For communication to take place, both the server (target) program and the Simulink software must
be executing. This does not mean that the model code in the server system must be executing. The
server can be waiting for the Simulink engine to issue a command to start model execution.

The client and server communicate by using bidirectional sockets carrying packets. Packets consist
either of messages (commands, parameter downloads, and responses) or data (signal uploads).

If the target application was invoked with the -w command-line option, the program enters a wait
state until it receives a message from the host. Otherwise, the program begins execution of the
model. While the target application is in a wait state, the Simulink engine can download parameters
to the target and configure data uploading.
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When the user chooses the Connect to Target option from the Simulation menu, the host initiates a
handshake by sending an EXT_CONNECT message. The server responds with information about itself.
This information includes

• Checksums. The host uses model checksums to determine that the target code is an exact
representation of the current Simulink model.

• Data format information. The host uses this information when formatting data to be downloaded,
or interpreting data that has been uploaded.

At this point, host and server are connected. The server is either executing the model or in the wait
state. (In the latter case, the user can begin model execution by selecting Start Real-Time Code
from the Simulation menu.)

During model execution, the message server runs as a background task. This task receives and
processes messages such as parameter downloads.

Data uploading comprises both foreground execution and background servicing of the signal packets.
As the target computes model outputs, it also copies signal values into data upload buffers. This
occurs as part of the task associated with each task identifier (tid). Therefore, data collection occurs
in the foreground. Transmission of the collected data, however, occurs as a background task. The
background task sends the data in the collection buffers to the Simulink engine by using data
packets.

The host initiates most exchanges as messages. The target usually sends a response confirming that
it has received and processed the message. Examples of messages and commands are:

• Connection message / connection response
• Start target simulation / start response
• Parameter download / parameter download response
• Arm trigger for data uploading / arm trigger response
• Terminate target simulation / target shutdown response

Model execution terminates when the model reaches its final time, when the host sends a terminate
command, or when a Stop Simulation block terminates execution. On termination, the server informs
the host that model execution has stopped, and shuts down its socket. The host also shuts down its
socket, and exits external mode.

External Mode Source Files
• “Client (Host) MEX-file Interface Source Files” on page 58-85
• “Server (Target) Source Files” on page 58-87
• “Other Files in the Server Folder” on page 58-88

Client (Host) MEX-file Interface Source Files

The source files for the MEX-file interface component are located in the folder matlabroot/
toolbox/coder/simulinkcoder_core/ext_mode/host (open), except as noted:

• common/ext_comm.c
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This file is the core of external mode communication. It acts as a relay station between the target
and the Simulink engine. ext_comm.c communicates to the Simulink engine by using a shared
data structure, ExternalSim. It communicates to the target by using calls to the transport layer.

Tasks carried out by ext_comm.c include establishment of a connection with the target,
downloading of parameters, and termination of the connection with the target.

• common/rtiostream_interface.c

This file is an interface between the external mode protocol and an rtiostream communications
channel. For more details on implementing an rtiostream communications channel, see
“Communications rtiostream API” on page 80-43. Implement your rtiostream communications
channel using the documented interface to avoid having to change the file
rtiostream_interface.c or other external mode related files.

• matlabroot/toolbox/coder/rtiostream/src/rtiostreamtcpip/rtiostream_tcpip.c

This file implements required TCP/IP transport layer functions. The version of
rtiostream_tcpip.c shipped with the Simulink Coder software uses TCP/IP functions including
recv(), send(), and socket().

• matlabroot/toolbox/coder/rtiostream/src/rtiostreamserial/
rtiostream_serial.c

This file implements required serial transport layer functions. The version of
rtiostream_serial.c shipped with the Simulink Coder software uses serial functions including
ReadFile(), WriteFile(), and CreateFile().

• serial/ext_serial_transport.c

This file implements required serial transport layer functions. ext_serial_transport.c
includes ext_serial_utils.c, which is located in matlabroot/rtw/c/src/ext_mode/
serial (open) and contains functions common to client and server sides.

• common/ext_main.c

This file is a MEX-file wrapper for external mode. ext_main.c interfaces to the Simulink engine
by using the standard mexFunction call. (See the mexFunction reference page and “Choosing a
MATLAB API for Your Application” for more information.) ext_main.c contains a function
dispatcher, esGetAction, that sends requests from the Simulink engine to ext_comm.c.

• common/ext_convert.c and ext_convert.h

This file contains functions used for converting data from host to target formats (and vice versa).
Functions include byte-swapping (big to little- endian), conversion from non-IEEE floats to IEEE
doubles, and other conversions. These functions are called both by ext_comm.c and directly by
the Simulink engine (by using function pointers).

Note You do not need to customize ext_convert to implement a custom transport layer.
However, you might want to customize ext_convert for the intended target. For example, if the
target represents the float data type in Texas Instruments format, ext_convert must be
modified to perform a Texas Instruments to IEEE conversion.

• common/extsim.h

This file defines the ExternalSim data structure and access macros. This structure is used for
communication between the Simulink engine and ext_comm.c.
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• common/extutil.h

This file contains only conditionals for compilation of the assert macro.
• common/ext_transport.h

This file defines functions that must be implemented by the transport layer.

Server (Target) Source Files

These files are linked into the model.exe executable. They are located within
matlabroot/rtw/c/src/ext_mode (open) except as noted.

• common/ext_svr.c

ext_svr.c is analogous to ext_comm.c on the host, but generally is responsible for more tasks.
It acts as a relay station between the host and the generated code. Like ext_comm.c, ext_svr.c
carries out tasks such as establishing and terminating connection with the host. ext_svr.c also
contains the background task functions that either write downloaded parameters to the target
model, or extract data from the target data buffers and send it back to the host.

• common/rtiostream_interface.c

This file is an interface between the external mode protocol and an rtiostream communications
channel. For more details on implementing an rtiostream communications channel, see
“Communications rtiostream API” on page 80-43. Implement your rtiostream communications
channel by using the documented interface to avoid having to change the file
rtiostream_interface.c or other external mode related files.

• matlabroot/toolbox/coder/rtiostream/src/rtiostreamtcpip/rtiostream_tcpip.c

This file implements required TCP/IP transport layer functions. The version of
rtiostream_tcpip.c shipped with the Simulink Coder software uses TCP/IP functions including
recv(), send(), and socket().

• matlabroot/toolbox/coder/rtiostream/src/rtiostreamserial/
rtiostream_serial.c

This file implements required serial transport layer functions. The version of rtiostream_serial.c
shipped with the software uses serial functions including ReadFile(), WriteFile(), and
CreateFile().

• matlabroot/toolbox/coder/rtiostream/src/rtiostream.h

This file defines the rtIOStream* functions implemented in rtiostream_tcpip.c.
• serial/ext_svr_serial_transport.c

This file implements required serial transport layer functions. ext_svr_serial_transport.c
includes serial/ext_serial_utils.c, which contains functions common to client and server
sides.

• common/updown.c

updown.c handles the details of interacting with the target model. During parameter downloads,
updown.c does the work of installing the new parameters into the model's parameter vector. For
data uploading, updown.c contains the functions that extract data from the model's blockio
vector and write the data to the upload buffers. updown.c provides services both to ext_svr.c
and to the model code (for example, grt_main.c). It contains code that is called by using the
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background tasks of ext_svr.c as well as code that is called as part of the higher priority model
execution.

• matlabroot/rtw/c/src/dt_info.h (included by generated model build file model.h)

These files contain data type transition information that allows access to multi-data type
structures across different computer architectures. This information is used in data conversions
between host and target formats.

• common/updown_util.h

This file contains only conditionals for compilation of the assert macro.
• common/ext_svr_transport.h

This file defines the Ext* functions that must be implemented by the server (target) transport
layer.

Other Files in the Server Folder

• common/ext_share.h

Contains message code definitions and other definitions required by both the host and target
modules.

• serial/ext_serial_utils.c

Contains functions and data structures for communication, MEX link, and generated code
required by both the host and target modules of the transport layer for serial protocols.

• The serial transport implementation includes the additional files

• serial/ext_serial_pkt.c and ext_serial_pkt.h
• serial/ext_serial_port.h

Implement a Custom Transport Layer
• “Requirements for Custom Transport Layers” on page 58-88
• “Create a Custom Client (Host) Transport Protocol” on page 58-88
• “MATLAB Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 58-89
• “Register a Custom Client (Host) Transport Protocol” on page 58-90
• “Create a Custom Server (Target) Transport Protocol” on page 58-91
• “Serial Receive Buffer Smaller than 64 Bytes” on page 58-92

Requirements for Custom Transport Layers

• By default, ext_svr.c and updown.c use malloc to allocate buffers in target memory for
messages, data collection, and other purposes, although there is also an option to preallocate
static memory. If your target uses another memory allocation scheme, you must modify these
modules.

• The target is assumed to support both int32_T and uint32_T data types.

Create a Custom Client (Host) Transport Protocol

To implement the client (host) side of your low-level transport protocol,
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1 Edit the template file matlabroot/toolbox/coder/rtiostream/src/rtiostreamtcpip/
rtiostream_tcpip.c to replace low-level communication calls with your own communication
calls.

a Copy and rename the file to rtiostream_name.c (replacing name with a name meaningful
to you).

b Replace the functions rtIOStreamOpen, rtIOStreamClose, rtIOStreamSend, and
rtIOStreamRecv with functions (of the same name) that call your low-level communication
primitives. These functions are called from other external mode modules via
rtiostream_interface.c. For more information, see “Communications rtiostream API”
on page 80-43.

c Build your rtiostream implementation into a shared library that exports the
rtIOStreamOpen, rtIOStreamClose, rtIOStreamRecv and rtIOStreamSend functions.

2 Build the customized MEX-file executable using the MATLAB mex function. See “MATLAB
Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 58-89 for examples
of mex invocations.

Do not replace the existing ext_comm MEX-file if you want to preserve its functionality. Instead,
use the -output option to name the new executable file, for example, my_ext_comm. For more
information, see mex.

3 Register your new client transport layer with the Simulink software, so that the transport can be
selected for a model using the Interface pane of the Configuration Parameters dialog box. For
details, see “Register a Custom Client (Host) Transport Protocol” on page 58-90.

Sample commands for rebuilding external mode MEX-files are listed in “MATLAB Commands to
Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 58-89.

MATLAB Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files

The following table lists the commands for building the standard ext_comm and ext_serial_win32
modules on PC and UNIX platforms.

Platform Commands
Windows, TCP/IP cd (matlabroot)

mex toolbox/coder/simulinkcoder_core/ext_mode/host/common/ext_comm.c ...
toolbox/coder/simulinkcoder_core/ext_mode/host/common/ext_convert.c ...
toolbox/coder/simulinkcoder_core/ext_mode/host/common/rtiostream_interface.c ...
toolbox/coder/simulinkcoder_core/ext_mode/host/common/ext_util.c ...
-R2018a ...
-Itoolbox/coder/rtiostream/src ...
-Itoolbox/coder/rtiostream/src/utils_host ...
-Itoolbox/coder/simulinkcoder_core/ext_mode/host/common/include ...
-Irtw/c/src/ext_mode/common ...
-lmwrtiostreamutils -lmwsl_services ...
-DEXTMODE_TCPIP_TRANSPORT ...
-DSL_EXT_DLL -output my_ext_comm

Note The rtiostream_interface.c function defines RTIOSTREAM_SHARED_LIB as
libmwrtiostreamtcpip and dynamically loads the MathWorks TCP/IP rtiostream
shared library. Modify this file if you need to load a different rtiostream shared library.
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Platform Commands
Linux, TCP/IP Use the Windows commands, with these changes:

• Change -DSL_EXT_DLL to -DSL_EXT_SO.
• Replace back slashes with forward slashes.

Mac, TCP/IP Use the Windows commands, with these changes:

• Change -DSL_EXT_DLL to -DSL_EXT_DYLIB.
• Replace back slashes with forward slashes.

Windows, serial cd (matlabroot)
mex toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_comm.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_convert.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\serial\ext_serial_transport.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\serial\ext_serial_pkt.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\serial\rtiostream_serial_interface.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_util.c ...
-R2018a ...
-Itoolbox\coder\rtiostream\src ...
-Itoolbox\coder\rtiostream\src\utils_host ...
-Itoolbox\coder\simulinkcoder_core\ext_mode\host\common ...
-Itoolbox\coder\simulinkcoder_core\ext_mode\host\common\include ...
-Irtw\c\src\ext_mode\common ...
-Irtw\c\src\ext_mode\serial ...
-lmwrtiostreamutils -lmwsl_services ...
-DEXTMODE_SERIAL_TRANSPORT -DSL_EXT_DLL ...
-output my_ext_serial_comm

Note The rtiostream_interface.c function defines RTIOSTREAM_SHARED_LIB as
libmwrtiostreamserial and dynamically loads the MathWorks serial rtiostream
shared library. Modify this file if you need to load a different rtiostream shared library.

Linux, serial Use the Windows commands, with these changes:

• Change -DSL_EXT_DLL to -DSL_EXT_SO.
• Replace back slashes with forward slashes.

Mac, serial Use the Windows commands, with these changes:

• Change -DSL_EXT_DLL to -DSL_EXT_DYLIB.
• Replace back slashes with forward slashes.

Note mex requires a compiler supported by the MATLAB API. See the mex reference page and
“Choosing a MATLAB API for Your Application” for more information about the mex function.

Register a Custom Client (Host) Transport Protocol

To register a custom client transport protocol with the Simulink software, you must add an entry of
the following form to an sl_customization.m file on the MATLAB path:
function sl_customization(cm)
  cm.ExtModeTransports.add('stf.tlc', 'transport', 'mexfile', 'Level1');
% -- end of sl_customization

where
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• stf.tlc is the name of the system target file for which the transport will be registered (for
example, 'grt.tlc')

• transport is the transport name to display in the Transport layer menu on the Interface pane
of the Configuration Parameters dialog box (for example, 'mytcpip')

• mexfile is the name of the transport's associated external interface MEX-file (for example,
'ext_mytcpip_comm')

You can specify multiple targets and/or transports with additional cm.ExtModeTransports.add
lines, for example:
function sl_customization(cm)
  cm.ExtModeTransports.add('grt.tlc', 'mytcpip', 'ext_mytcpip_comm', 'Level1');
  cm.ExtModeTransports.add('ert.tlc', 'mytcpip', 'ext_mytcpip_comm', 'Level1');
% -- end of sl_customization

If you place the sl_customization.m file containing the transport registration information on the
MATLAB path, your custom client transport protocol will be registered with each subsequent
Simulink session. The name of the transport will appear in the Transport layer menu on the
Interface pane of the Configuration Parameters dialog box. When you select the transport for your
model, the name of the associated external interface MEX-file will appear in the noneditable MEX-file
name field, as shown in the following figure.

Create a Custom Server (Target) Transport Protocol

The rtIOStream* function prototypes in matlabroot/toolbox/coder/rtiostream/src/
rtiostream.h define the calling interface for both the server (target) and client (host) side
transport layer functions.

• The TCP/IP implementations are in matlabroot/toolbox/coder/rtiostream/src/
rtiostreamtcpip/rtiostream_tcpip.c.

• The serial implementations are in matlabroot/toolbox/coder/rtiostream/src/
rtiostreamserial/rtiostream_serial.c.

Note The Ext* function prototypes in matlabroot/rtw/c/src/ext_mode/common/
ext_svr_transport.h are implemented in matlabroot/rtw/c/src/ext_mode/common/
rtiostream_interface.c or matlabroot/rtw/c/src/ext_mode/serial/
rtiostream_serial_interface.c. In most cases you will not need to modify
rtiostream_interface.c or rtiostream_serial_interface.c for your custom TCP/IP or
serial transport layer.

To implement the server (target) side of your low-level TCP/IP or serial transport protocol:
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1 Edit the template matlabroot/toolbox/coder/rtiostream/src/rtiostreamtcpip/
rtiostream_tcpip.c or matlabroot/toolbox/coder/rtiostream/src/
rtiostreamserial/rtiostream_serial.c to replace low-level communication calls with
your own communication calls.

a Copy and rename the file to rtiostream_name.c (replacing name with a name meaningful
to you).

b Replace the functions rtIOStreamOpen, rtIOStreamClose, rtIOStreamSend, and
rtIOStreamRecv with functions (of the same name) that call your low-level communication
drivers.

You must implement the functions defined in rtiostream.h, and your implementations
must conform to the prototypes defined in that file. Refer to the original
rtiostream_tcpip.c or rtiostream_serial.c for guidance.

2 Incorporate the external mode source files for your transport layer into the model build process.
Use a build process mechanism such as a post code generation command or a before_make
hook function to make the transport files available to the build process. For more information on
the build process mechanisms, see “Customize Post-Code-Generation Build Processing”,
“Customize Build Process with STF_make_rtw_hook File”, and “Customize Build Process with
sl_customization.m”.

For example:

• Add the file created in the previous step to the build information:

path/rtiostream_name.c

• For TCP/IP, add the following file to the build information:

matlabroot/rtw/c/src/ext_mode/common/rtiostream_interface.c

• For serial, add the following files to the build information:

matlabroot/rtw/c/src/ext_mode/serial/ext_serial_pkt.c
matlabroot/rtw/c/src/ext_mode/serial/rtiostream_serial_interface.c
matlabroot/rtw/c/src/ext_mode/serial/ext_svr_serial_transport.c

Note For external mode, check that rtIOStreamRecv is not a blocking implementation. Otherwise,
it might cause the external mode server to block until the host sends data through the comm layer.

Serial Receive Buffer Smaller than 64 Bytes

For serial communication, if the serial receive buffer of your target is smaller than 64 bytes:

1 Update the following macro with the actual target buffer size:

#define TARGET_SERIAL_RECEIVE_BUFFER_SIZE 64

Implement the change in the following files:

matlabroot/rtw/c/src/ext_mode/serial/ext_serial_utils.c
matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host/serial/ext_serial_utils.c

2 Run the command to rebuild the ext_serial_win32 MEX-file. See “MATLAB Commands to
Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 58-89.
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See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
• “External Mode Simulation with TCP/IP or Serial Communication” on page 58-44
• “Customize Connectivity for TCP/IP or Serial External Mode Simulations” on page 58-33
• “External Mode Simulations for Parameter Tuning and Signal Monitoring” on page 58-2
• “Customize XCP Slave Software” on page 58-35
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Log Program Execution Results
Multiple techniques are available by which a program generated by the Simulink Coder software can
save data to a MAT-file for analysis. A generated executable can save system states, outputs, and
simulation time at each model execution time step. The data is written to a MAT-file, named (by
default) model.mat, where model is the name of your model. See “Log Data for Analysis” on page
59-2 for a data logging tutorial.

Note Data logging is available only for system target files that have access to a file system. In
addition, only the RSim target executables are capable of accessing MATLAB workspace data.

For MAT-file logging limitations, see the configuration parameter “MAT-file logging”.

Log Data for Analysis
• “Set Up and Configure Model” on page 59-2
• “Data Logging During Simulation” on page 59-3
• “Data Logging from Generated Code” on page 59-6

Set Up and Configure Model

This example shows how data generated by a copy of the model slexAircraftExample is logged to
the file myAircraftExample.mat. Refer to “Build Process Workflow for Real-Time Systems” on
page 57-25 for instructions on setting up a copy of slexAircraftExample asmyAircraftExample
in a working folder if you have not done so already.

Note When you configure the code generator to produce code that includes support for data logging
during execution, the code generator can include text for block names in the block paths included in
the log file. If the text includes characters that are unrepresented in the character set encoding for
the model, the code generator replaces the characters with XML escape sequences. For example, the
code generator replaces the Japanese full-width Katakana letter ア with the escape sequence
&#x30A2;. For more information, see “Internationalization and Code Generation”.

To configure data logging, open the Configuration Parameters dialog box and select the Data
Import/Export pane. The process is the same as configuring a Simulink model to save output to the
MATLAB workspace. For each workspace return variable you define and enable, the Simulink Coder
software defines a parallel MAT-file variable. For example, if you save simulation time to the variable
tout, your generated program logs the same data to a variable named rt_tout. You can change the
prefix rt_ to a suffix (_rt), or eliminate it entirely. You do this by setting model configuration
parameter MAT-file variable name modifier.

Simulink lets you log signal data from anywhere in a model. In the Simulink Editor, select the signals
that you want to log and then in the Simulation Data Inspector button drop-down, select Log
Selected Signals. However, the code generator does not use this method of signal logging in
generated code. To log signals in generated code, use the Data Import/Export parameters described
below or include To File or To Workspace blocks in your model.
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Note If you enable MAT-file and signal logging (through the Data Import/Export pane) and select
signals for logging (through the Simulink Editor), you see the following warning when you build the
model:
Warning: MAT-file logging does not support signal logging.
When your model code executes, the signal logging variable 'rt_logsout' will
not be saved to the MAT-file. 

To avoid this warning, clear the model configuration parameter Signal logging.

In this example, you modify the myAircraftExample model so that the generated program saves
the simulation time and system outputs to the file myAircraftExample.mat. Then you load the data
into the base workspace and plot simulation time against one of the outputs. The
myAircraftExample model should be configured as described in “Build Process Workflow for Real-
Time Systems” on page 57-25.

Data Logging During Simulation

To use the data logging feature:

1 Open the myAircraftExample model if it is not already open.
2 Open the Configuration Parameters dialog box.
3 Select the Data Import/Export pane. The Data Import/Export pane lets you specify which

outport data is to be saved to the workspace and what variable names to use for it.
4 Set parameter Format to Structure with time. When you select this format, Simulink saves

the model states and outputs in structures that have their names specified in the Save to
workspace or file area. By default, the structures are xout for states and yout for output. The
structure used to save output has two top-level fields: time and signals. The time field
contains a vector of simulation times and signals contains an array of substructures, each of
which corresponds to a model output port.

5 Select Output. This tells Simulink to save output signal data during simulation as a variable
named yout. Selecting Output enables the code generator to create code that logs the root
Output block (alpha, rad) to a MAT-file.

6 Set Decimation to 1.
7 If other parameters are selected, clear them. The figure below shows how the dialog box should

appear.
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8 Click Apply and OK to register your changes and close the dialog box.
9 Save the model.
10 In the model window, double-click the scope symbol next to the Aircraft Dynamics Model block,

then simulate the model. The resulting scope display is shown below.
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11 Verify that the simulation time and outputs have been saved to the base workspace in MAT-files.
At the MATLAB prompt, type:

whos yout

Simulink displays:
  Name        Size            Bytes  Class     Attributes

  yout        1x1             10756  struct

12 Verify that alpha, rad was logged by plotting simulation time versus that variable. In the
Command Window, type:

plot(yout.time,yout.signals.values)

The resulting plot is shown below.
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Data Logging from Generated Code

In the second part of this example, you build and run an executable program built by the code
generator for model myAircraftExample. The program outputs a MAT-file containing the simulation
time and output you previously examined. Even though you have already generated code for the
myAircraftExample model, you must now regenerate that code because you have changed the
model by enabling data logging. The steps below explain this procedure.

To avoid overwriting workspace data with data from simulation runs, the code generator modifies
identifiers for variables logged by Simulink. You can control these modifications.

1 Set model configuration parameter MAT-file variable name modifier to _rt. This adds the
suffix _rt to each variable that you selected to be logged in the first part of this example.

2 Click Apply and OK to register your changes and close the dialog box.
3 Save the model.
4 Build an executable.
5 When the build concludes, run the executable program with the command:

!myAircraftExample
6 The program now produces two message lines, indicating that the MAT-file has been written.

** starting the model **
** created myAircraftExample.mat **

7 Load the MAT-file data created by the executable and look at the workspace variables from
simulation and the generated program by typing:

load myAircraftExample.mat
whos yout*

Simulink displays:

  Name           Size            Bytes  Class     Attributes

  yout           1x1             10756  struct
  yout_rt        1x1             10756  struct

Note the size and bytes of the structures resulting from the simulation run and generated code
are the same.

8 Plot the generated code output by entering the following command in the Command Window:

plot(yout_rt.time,yout_rt.signals.values)
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The plot should be identical to the plot that you produced in the previous part of this example.

Tip For UNIX platforms, run the executable program in the Command Window with the syntax !./
executable_name. If preferred, run the executable program from an OS shell with the syntax ./
executable_name. For more information, see “Run External Commands, Scripts, and Programs”.

Configure State, Time, and Output Logging
The Data Import/Export pane enables a generated program to save system states, outputs, and
simulation time at each model execution time step. The data is written to a MAT-file, named (by
default) model.mat.

Before using this data logging feature, you should learn how to configure a Simulink model to return
output to the MATLAB workspace. This is discussed in “Export Simulation Data”.

For each workspace return variable that you define and enable, the code generator defines a MAT-file
variable. For example, if your model saves simulation time to the workspace variable tout, your
generated program logs the same data to a variable named (by default) rt_tout.

The code generated by the code generator logs the following data:

• Root Outport blocks

The default MAT-file variable name for system outputs is rt_yout.

The sort order of the rt_yout array is based on the port number of the Outport block, starting
with 1.

• Continuous and discrete states in the model

The default MAT-file variable name for system states is rt_xout.
• Simulation time

The default MAT-file variable name for simulation time is rt_tout.
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• “Override Default MAT-File Variable Names” on page 59-8
• “Override Default MAT-File Name or Buffer Size” on page 59-8

Override Default MAT-File Variable Names

By default, the code generator prefixes the text rt_ to the variable names for system outputs, states,
and simulation time to form MAT-file variable names. To change this prefix for a model, set model
configuration parameter MAT-file variable name modifier to (rt_), a suffix (_rt), or no modifier
(none). Other system target files might not support this parameter.

Override Default MAT-File Name or Buffer Size

You can specify compiler options to override the following MAT-file attributes in generated code:

MAT-File Attribute Default Compiler Option
Name model.mat -DSAVEFILE=filename
Size of data logging buffer 1024 bytes -DDEFAULT_BUFFER_SIZE=n

Note Valid option syntax can vary among compilers. For example, Microsoft Visual C++ compilers
typically accept /DSAVEFILE=filename as well as -DSAVEFILE=filename.

For a template makefile (TMF) based target, set model configuration parameter Make command to
the compiler option. For example:

For a toolchain-based system target file such as GRT or ERT, add the compiler option to model
configuration. Set parameter Build configuration to Specify, and add the compiler option to the C
Compiler row of the Tool/Options table. For example:

To add the compiler option to a custom toolchain, you can modify and reregister the custom toolchain
using the procedures shown in the example “Add Custom Toolchains to MATLAB® Coder™ Build
Process”. For example, to add the compiler option to the MATLAB source file for the custom
toolchain, you could define myCompilerOpts as follows:
optimsOffOpts    = {'/c /Od'};
optimsOnOpts     = {'/c /O2'};
cCompilerOpts    = '$(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL)';
cppCompilerOpts  = '$(cflags) $(CVARSFLAG) $(CPPFLAGS_ADDITIONAL)';
myCompilerOpts   = {' -DSAVEFILE=myCodeLog.mat '};
...

Then you can add myCompilerOpts to the flags for each configuration and compiler to which it
applies, for example:
cfg = tc.getBuildConfiguration('Faster Builds');
cfg.setOption('C Compiler', horzcat(cCompilerOpts, myCompilerOpts, optimsOffOpts));

As shown in “Add Custom Toolchains to MATLAB® Coder™ Build Process”, after modifying the
custom toolchain, you save the configuration to a MAT-file and refresh the target registry.
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Log Data with Scope and To Workspace Blocks
The code generated by the code generator also logs data from these sources:

• Scope blocks that have the block parameter Log data to workspace enabled

You must specify the variable name and data format in each Scope block's dialog box.
• To Workspace blocks in the model

You must specify the variable name and data format in each To Workspace block's dialog box.

The variables are written to model.mat, along with variables logged from the Workspace I/O pane.

Log Data with To File Blocks
You can also log data to a To File block. The generated program creates a separate MAT-file (distinct
from model.mat) for each To File block in the model. The file contains the block time and input
variable(s). You must specify the filename, variable names, decimation, and sample time in the To File
block dialog box.

Note  Models referenced by Model blocks do not perform data logging in that context except for
states, which you can include in the state logged for top models. Code generated by the Simulink
Coder software for referenced models does not perform data logging to MAT-files.

Data Logging Differences Between Single- and Multitasking
When logging data in single-tasking and multitasking systems, you will notice differences in the
logging of

• Noncontinuous root Outport blocks
• Discrete states

In multitasking mode, the logging of states and outputs is done after the first task execution (and not
at the end of the first time step). In single-tasking mode, the code generated by the build procedure
logs states and outputs after the first time step.

See Data Logging in Single-Tasking and Multitasking Model Execution for more details on the
differences between single-tasking and multitasking data logging.

Note The rapid simulation target (RSim) provides enhanced logging options. See “Accelerate, Refine,
and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” for more
information.

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
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• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Data Interchange Using the C API in
Simulink Coder

• “Exchange Data Between Generated and External Code Using C API” on page 60-2
• “Use C API to Access Model Signals and States” on page 60-18
• “Use C API to Access Model Parameters” on page 60-23
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Exchange Data Between Generated and External Code Using C
API

Some Simulink Coder applications must interact with signals, states, root-level inputs/outputs, or
parameters in the generated code for a model. For example, calibration applications monitor and
modify parameters. Signal monitoring or data logging applications interface with signal, state, and
root-level input/output data. Using the Simulink Coder C API, you can build target applications that
log signals, states, and root-level inputs/outputs, monitor signals, states, and root-level inputs/
outputs, and tune parameters, while the generated code executes.

The C API minimizes its memory footprint by sharing information common to signals, states, root-
level inputs/outputs, and parameters in smaller structures. Signal, state, root-level input/output, and
parameter structures include an index into the structure map, allowing multiple signals, states, root-
level inputs/outputs, or parameters to share data.

To get started with an example, see “Use C API to Access Model Signals and States” on page 60-18
or “Use C API to Access Model Parameters” on page 60-23.

In this section...
“Generated C API Files” on page 60-2
“Generate C API Files” on page 60-3
“Description of C API Files” on page 60-4
“Generate C API Data Definition File for Exchanging Data with a Target System” on page 60-15
“C API Limitations” on page 60-16

Generated C API Files
When you configure a model to use the C API, the Simulink Coder code generator generates two
additional files, model_capi.c (or .cpp) and model_capi.h, where model is the name of the
model. The code generator places the two C API files in the build folder, based on settings in the
Configuration Parameters dialog box. The C API source code file contains information about global
block output signals, states, root-level inputs/outputs, and global parameters defined in the generated
code model source code. The C API header file is an interface header file between the model source
code and the generated C API. You can use the information in these C API files to create your
application. Among the files generated are those shown in the next figure.

Generated Files with C API Selected
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Note When you configure the code generator to produce code that includes support for the C API
interface and data logging, the code generator can include text for block names in the block paths
logged to C API files model_capi.c (or .cpp) and model_capi.h. If the text includes characters
that are unrepresented in the character set encoding for the model, the code generator replaces the
characters with XML escape sequences. For example, the code generator replaces the Japanese full-
width Katakana letter ア with the escape sequence &#x30A2;. For more information, see
“Internationalization and Code Generation”.

Generate C API Files
To generate C API files for your model:

1 Select the C API interface for your model. There are two ways to select the C API interface for
your model, as described in the following sections.

• “Select C API with Configuration Parameters Dialog” on page 60-3
• “Select C API from the Command Line” on page 60-3

2 Generate code for your model.

After generating code, you can examine the files model_capi.c (or .cpp) and model_capi.h in the
model build folder.

Select C API with Configuration Parameters Dialog
1 Open your model, and open the Configuration Parameters dialog box.
2 In the Code Generation > Interface pane, in the Data exchange interface subgroup, select

one or more C API options. Based on the options you select, support for accessing signals,
parameters, states, and root-level I/O will appear in the C API generated code.

• If you want to generate C API code for global block output signals, select Generate C API
for: signals.

• If you want to generate C API code for global block parameters, select Generate C API for:
parameters.

• If you want to generate C API code for discrete and continuous states, select Generate C API
for: states.

• If you want to generate C API code for root-level inputs and outputs, select Generate C API
for: root-level I/O.

Select C API from the Command Line

From the MATLAB command line, you can use the set_param function to select or clear C API model
configuration parameters. At the MATLAB command line, enter one or more of the following
commands, where modelname is the name of your model.

To select Generate C API for: signals, enter:

set_param('modelname','RTWCAPISignals','on')

To clear Generate C API for: signals, enter:

set_param('modelname','RTWCAPISignals','off')

To select Generate C API for: parameters, enter:
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set_param('modelname','RTWCAPIParams','on')

To clear Generate C API for: parameters, enter:

set_param('modelname','RTWCAPIParams','off')

To select Generate C API for: states, enter:

set_param('modelname','RTWCAPIStates','on')

To clear Generate C API for: states, enter:

set_param('modelname','RTWCAPIStates','off')

To select Generate C API for: root-level I/O, enter:

set_param('modelname','RTWCAPIRootIO','on')

To clear Generate C API for: root-level I/O, enter:

set_param('modelname','RTWCAPIRootIO','off')

Description of C API Files
• “About C API Files” on page 60-4
• “Structure Arrays Generated in C API Files” on page 60-6
• “Generate Example C API Files” on page 60-8
• “C API Signals” on page 60-8
• “C API States” on page 60-11
• “C API Root-Level Inputs and Outputs” on page 60-11
• “C API Parameters” on page 60-12
• “Map C API Data Structures to rtModel” on page 60-14

About C API Files

The model_capi.c (or .cpp) file provides external applications with a consistent interface to model
data. Depending on your configuration settings, the data could be a signal, state, root-level input or
output, or parameter. In this document, the term data item refers to either a signal, a state, a root-
level input or output, or a parameter. The C API uses structures that provide an interface to the data
item properties. The interface packages the properties of each data item in a data structure. If the
model contains multiple data items, the interface generates an array of data structures. The members
of a data structure map to data properties.

To interface with data items, an application requires the following properties for each data item:

• Name
• Block path
• Port number (for signals and root-level inputs/outputs only)
• Address
• Data type information: native data type, data size, complexity, and other attributes
• Dimensions information: number of rows, number of columns, and data orientation (scalar, vector,

matrix, or n-dimensional)
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• Fixed-point information: slope, bias, scale type, word length, exponent, and other attributes
• Sample-time information (for signals, states, and root-level inputs/outputs only): sample time, task
identifier, frames

As illustrated in the next figure, the properties of data item A, for example, are located in data
structure DS_A. The properties of data item B are located in data structure DS_B.

Some property values can be unique to each data item, and there are some property values that
several data items can share in common. Name, for example, has a unique value for each data item.
The interface places the unique property values directly in the structure for the data item. The name
value of data item A is in DS_A, and the name value of data item B is in DS_B.

But data type could be a property whose value several data items have in common. The ability of
some data items to share a property allows the C API to have a reuse feature. In this case, the
interface places only an index value in DS_A and an index value in DS_B. These indices point to a
different data structure, DS_C, that contains the actual data type value. The next figure shows this
scheme with more detail.
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The figure shows three signals. signal1 and signal2 share the same data type, double. Instead of
specifying this data type value in each signal data structure, the interface provides only an index
value, 0, in the structure. "double" is described by entry 0 in the rtDataTypeMap array, which is
referenced by both signals. Additionally, property values can be shared between signals, states, root-
level inputs/outputs, and parameters, so states, root-level inputs/outputs, and parameters also might
reference the double entry in the rtDataTypeMap array. This reuse of information reduces the
memory size of the generated interface.

Structure Arrays Generated in C API Files

As with data type, the interface maps other common properties (such as address, dimension, fixed-
point scaling, and sample time) into separate structures and provides an index in the structure for the
data item. For a complete list of structure definitions, refer to the file matlabroot/rtw/c/src/
rtw_capi.h. This file also describes each member in a structure. The structure arrays generated in
the model_capi.c (or .cpp) file are of structure types defined in the rtw_capi.h file. Here is a
brief description of the structure arrays generated in model_capi.c (or .cpp):
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• rtBlockSignals is an array of structures that contains information about global block output
signals in the model. Each element in the array is of type struct rtwCAPI_Signals. The
members of this structure provide the signal name, block path, block port number, address, and
indices to the data type, dimension, fixed-point, and sample-time structure arrays.

• rtBlockParameters is an array of structures that contains information about the tunable block
parameters in the model by block name and parameter name. Each element in the array is of type
struct rtwCAPI_BlockParameters. The members of this structure provide the parameter
name, block path, address, and indices to data type, dimension, and fixed-point structure arrays.

• rtBlockStates is an array of structures that contains information about discrete and continuous
states in the model. Each element in the array is of type struct rtwCAPI_States. The
members of this structure provide the state name, block path, type (continuous or discrete), and
indices to the address, data type, dimension, fixed-point, and sample-time structure arrays.

• rtRootInputs is an array of structures that contains information about root-level inputs in the
model. Each element in the array is of type struct rtwCAPI_Signals. The members of this
structure provide the root-level input name, block path, block port number, address, and indices to
the data type, dimension, fixed-point, and sample-time structure arrays.

• rtRootOutputs is an array of structures that contains information about root-level outputs in the
model. Each element in the array is of type struct rtwCAPI_Signals. The members of this
structure provide the root-level output name, block path, block port number, address, and indices
to the data type, dimension, fixed-point, and sample-time structure arrays.

• rtModelParameters is an array of structures that contains information about workplace
variables that one or more blocks or Stateflow charts in the model reference as block parameters.
Each element in the array is of data type rtwCAPI_ModelParameters. The members of this
structure provide the variable name, address, and indices to data type, dimension, and fixed-point
structure arrays.

• rtDataAddrMap is an array of base addresses of signals, states, root-level inputs/outputs, and
parameters that appear in the rtBlockSignals, rtBlockParameters, rtBlockStates, and
rtModelParameters arrays. Each element of the rtDataAddrMap array is a pointer to void
(void*).

• rtDataTypeMap is an array of structures that contains information about the various data types
in the model. Each element of this array is of type struct rtwCAPI_DataTypeMap. The
members of this structure provide the data type name, size of the data type, and information on
whether or not the data is complex.

• rtDimensionMap is an array of structures that contains information about the various data
dimensions in the model. Each element of this array is of type struct rtwCAPI_DimensionMap.
The members of this structure provide information on the number of dimensions in the data, the
orientation of the data (whether it is scalar, vector, or a matrix), and the actual dimensions of the
data.

• rtFixPtMap is an array of structures that contains fixed-point information about the signals,
states, root-level inputs/outputs, and parameters. Each element of this array is of type struct
rtwCAPI_FixPtMap. The members of this structure provide information about the data scaling,
bias, exponent, and whether or not the fixed-point data is signed. If the model does not have fixed-
point data (signal, state, root-level input/output, or parameter), the Simulink Coder software
assigns NULL or zero values to the elements of the rtFixPtMap array.

• rtSampleTimeMap is an array of structures that contains sampling information about the global
signals, states, and root-level inputs/outputs in the model. (This array does not contain information
about parameters.) Each element of this array is of type struct rtwCAPI_SampleTimeMap. The
members of this structure provide information about the sample period, offset, and whether or not
the data is frame-based or sample-based.
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Generate Example C API Files

Subtopics “C API Signals” on page 60-8, “C API States” on page 60-11, “C API Root-Level Inputs
and Outputs” on page 60-11, and “C API Parameters” on page 60-12 discuss generated C API
structures using the example model rtwdemo_capi. To generate code from the example model, do
the following:

1 Open the model by clicking the rtwdemo_capi link above or by typing rtwdemo_capi on the
MATLAB command line.

2 If you want to generate C API structures for root-level inputs/outputs in rtwdemo_capi, select
model configuration parameter Generate C API for: root-level I/O.

The setting this parameter must match between the top model and the referenced model. If you
modify the parameter setting, save the top model and the referenced model to the same writable
work folder.

3 Generate code for the model.

The C API code examples in the next subtopics are generated with C as the target language.

This model has three global block output signals that will appear in C API generated code:

• top_sig1, which is a test point at the output of the Gain1 block in the top model
• sig2_eg, which appears in the top model and is defined in the base workspace as a

Simulink.Signal object having storage class ExportedGlobal
• bot_sig1, which appears in the referenced model rtwdemo_capi_bot and is defined as a

Simulink.Signal object having storage class Model default

The model also has two discrete states that will appear in the C API generated code:

• top_state, which is defined for the Delay1 block in the top model
• bot_state, which is defined for the Discrete Filter block in the referenced model

The model has root-level inputs/outputs that will appear in the C API generated code if you select
model configuration parameter Generate C API for: root-level I/O:

• Four root-level inputs, In1 through In4
• Six root-level outputs, Out1 through Out6

Additionally, the model has five global block parameters that will appear in C API generated code:

• Kp (top model Gain1 block and referenced model Gain2 block share)
• Ki (referenced model Gain3 block)
• p1 (lookup table lu1d)
• p2 (lookup table lu2d)
• p3 (lookup table lu3d)

C API Signals

The rtwCAPI_Signals structure captures signal information including the signal name, address,
block path, output port number, data type information, dimensions information, fixed-point
information, and sample-time information.
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Here is the section of code in rtwdemo_capi_capi.c that provides information on C API signals for
the top model in rtwdemo_capi:

/* Block output signal information */
static const rtwCAPI_Signals rtBlockSignals[] = {
  /* addrMapIndex, sysNum, blockPath,
   * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex
   */
  { 0, 0, "rtwdemo_capi/Gain1",
    "top_sig1", 0, 0, 0, 0, 0 },

  { 1, 0, "rtwdemo_capi/lu2d",
    "sig2_eg", 0, 0, 1, 0, 0 },

  {
    0, 0, (NULL), (NULL), 0, 0, 0, 0, 0
  }
};

Note To better understand the code, read the comments in the file. For example, notice the comment
that begins on the third line in the preceding code. This comment lists the members of the
rtwCAPI_Signals structure, in order. This tells you the order in which the assigned values for each
member appear for a signal. In this example, the comment tells you that signalName is the fourth
member of the structure. The following lines describe the first signal:

  { 0, 0, "rtwdemo_capi/Gain1",
    "top_sig1", 0, 0, 0, 0, 0 },

From these lines you infer that the name of the first signal is top_sig1.

Each array element, except the last, describes one output port for a block signal. The final array
element is a sentinel, with all elements set to null values. For example, examine the second signal,
described by the following code:

  { 1, 0, "rtwdemo_capi/lu2d",
    "sig2_eg", 0, 0, 1, 0, 0 },

This signal, named sig2_eg, is the output signal of the first port of the block rtwdemo_capi/lu2d.
(This port is the first port because the zero-based index for portNumber displayed on the second line
is assigned the value 0.)

The address of this signal is given by addrMapIndex, which, in this example, is displayed on the first
line as 1. This provides an index into the rtDataAddrMap array, found later in
rtwdemo_capi_capi.c:

/* Declare Data Addresses statically */
static void* rtDataAddrMap[] = {
  &rtwdemo_capi_B.top_sig1,            /* 0: Signal */
  &sig2_eg[0],                         /* 1: Signal */
  &rtwdemo_capi_DWork.top_state,       /* 2: Discrete State */
  &rtP_Ki,                             /* 3: Model Parameter */
  &rtP_Kp,                             /* 4: Model Parameter */
  &rtP_p1[0],                          /* 5: Model Parameter */
  &rtP_p2[0],                          /* 6: Model Parameter */
  &rtP_p3[0],                          /* 7: Model Parameter */
};

The index of 1 points to the second element in the rtDataAddrMap array. From the rtDataAddrMap
array, you can infer that the address of this signal is &sig2_eg[0].
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This level of indirection supports multiple code instances of the same model. For multiple instances,
the signal information remains constant, except for the address. In this case, the model is a single
instance. Therefore, the rtDataAddrMap is declared statically. If you choose to generate reusable
code, an initialize function is generated that initializes the addresses dynamically per instance. For
details on generating reusable code, see “Configure C Code Generation for Model Entry-Point
Functions” and see “Configure Code Reuse Support” on page 48-10.

The dataTypeIndex provides an index into the rtDataTypeMap array, found later in
rtwdemo_capi_capi.c, indicating the data type of the signal:
/* Data Type Map - use dataTypeMapIndex to access this structure */
static const rtwCAPI_DataTypeMap rtDataTypeMap[] = {
  /* cName, mwName, numElements, elemMapIndex, dataSize, slDataId, *
   * isComplex, isPointer */
  { "double", "real_T", 0, 0, sizeof(real_T), SS_DOUBLE, 0, 0 }
};

Because the index is 0 for sig2_eg, the index points to the first structure element in the array. You
can infer that the data type of the signal is double. The value of isComplex is 0, indicating that the
signal is not complex. Rather than providing the data type information directly in the
rtwCAPI_Signals structure, a level of indirection is introduced. The indirection allows multiple
signals that share the same data type to point to one map structure, saving memory for each signal.

The dimIndex (dimensions index) provides an index into the rtDimensionMap array, found later in
rtwdemo_capi_capi.c, indicating the dimensions of the signal. Because this index is 1 for
sig2_eg, the index points to the second element in the rtDimensionMap array:
/* Dimension Map - use dimensionMapIndex to access elements of ths structure*/
static const rtwCAPI_DimensionMap rtDimensionMap[] = {
  /* dataOrientation, dimArrayIndex, numDims, vardimsIndex */
  { rtwCAPI_SCALAR, 0, 2, 0 },

  { rtwCAPI_VECTOR, 2, 2, 0 },
...
};

From this structure, you can infer that this is a nonscalar signal having a dimension of 2. The
dimArrayIndex value, 2, provides an index into rtDimensionArray, found later in
rtwdemo_capi_capi.c:
/* Dimension Array- use dimArrayIndex to access elements of this array */
static const uint_T rtDimensionArray[] = {
  1,                                   /* 0 */
  1,                                   /* 1 */
  2,                                   /* 2 */
...
};

The fxpIndex (fixed-point index) provides an index into the rtFixPtMap array, found later in
rtwdemo_capi_capi.c, indicating fixed-point information about the signal. Your code can use the
scaling information to compute the real-world value of the signal, using the equation V=SQ+B, where
V is “real-world” (that is, base-10) value, S is user-specified slope, Q is “quantized fixed-point value”
or “stored integer,” and B is user-specified bias. For details, see “Scaling” (Fixed-Point Designer).

Because this index is 0 for sig2_eg, the signal does not have fixed-point information. A fixed-point
map index of zero means that the signal does not have fixed-point information.

The sTimeIndex (sample-time index) provides the index to the rtSampleTimeMap array, found later
in rtwdemo_capi_capi.c, indicating task information about the signal. If you log multirate signals
or conditionally executed signals, the sampling information can be useful.
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Note model_capi.c (or .cpp) includes rtw_capi.h. A source file that references the
rtBlockSignals array also must include rtw_capi.h.

C API States

The rtwCAPI_States structure captures state information including the state name, address, block
path, type (continuous or discrete), data type information, dimensions information, fixed-point
information, and sample-time information.

Here is the section of code in rtwdemo_capi_capi.c that provides information on C API states for
the top model in rtwdemo_capi:
/* Block states information */
static const rtwCAPI_States rtBlockStates[] = {
  /* addrMapIndex, contStateStartIndex, blockPath,
   * stateName, pathAlias, dWorkIndex, dataTypeIndex, dimIndex,
   * fixPtIdx, sTimeIndex, isContinuous
   */
  { 2, -1, "rtwdemo_capi/Delay1",
    "top_state", "", 0, 0, 0, 0, 0, 0 },

  {
    0, -1, (NULL), (NULL), (NULL), 0, 0, 0, 0, 0, 0
  }
};

Each array element, except the last, describes a state in the model. The final array element is a
sentinel, with all elements set to null values. In this example, the C API code for the top model
displays one state:

  { 2, -1, "rtwdemo_capi/Delay1",
    "top_state", "", 0, 0, 0, 0, 0, 0 },

This state, named top_state, is defined for the block rtwdemo_capi/Delay1. The value of
isContinuous is zero, indicating that the state is discrete rather than continuous. The other fields
correspond to the like-named signal equivalents described in “C API Signals” on page 60-8, as
follows:

• The address of the signal is given by addrMapIndex, which, in this example, is 2. This is an index
into the rtDataAddrMap array, found later in rtwdemo_capi_capi.c. Because the index is zero
based, 2 corresponds to the third element in rtDataAddrMap, which is
&rtwdemo_capi_DWork.top_state.

• The dataTypeIndex provides an index into the rtDataTypeMap array, found later in
rtwdemo_capi_capi.c, indicating the data type of the parameter. The value 0 corresponds to a
double, noncomplex parameter.

• The dimIndex (dimensions index) provides an index into the rtDimensionMap array, found later
in rtwdemo_capi_capi.c. The value 0 corresponds to the first entry, which is
{ rtwCAPI_SCALAR, 0, 2, 0 }.

• The fixPtIndex (fixed-point index) provides an index into the rtFixPtMap array, found later in
rtwdemo_capi_capi.c, indicating fixed-point information about the parameter. As with the
corresponding signal attribute, a fixed-point map index of zero means that the parameter does not
have fixed-point information.

C API Root-Level Inputs and Outputs

The rtwCAPI_Signals structure captures root-level input/output information including the input/
output name, address, block path, port number, data type information, dimensions information, fixed-
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point information, and sample-time information. (This structure also is used for block output signals,
as previously described in “C API Signals” on page 60-8.)

Here is the section of code in rtwdemo_capi_capi.c that provides information on C API root-level
inputs/outputs for the top model in rtwdemo_capi:
/* Root Inputs information */
static const rtwCAPI_Signals rtRootInputs[] = {
  /* addrMapIndex, sysNum, blockPath,
   * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex
   */
  { 3, 0, "rtwdemo_capi/In1",
    "", 1, 0, 0, 0, 0 },

  { 4, 0, "rtwdemo_capi/In2",
    "", 2, 0, 0, 0, 0 },

  { 5, 0, "rtwdemo_capi/In3",
    "", 3, 0, 0, 0, 0 },

  { 6, 0, "rtwdemo_capi/In4",
    "", 4, 0, 0, 0, 0 },

  {
    0, 0, (NULL), (NULL), 0, 0, 0, 0, 0
  }
};

/* Root Outputs information */
static const rtwCAPI_Signals rtRootOutputs[] = {
  /* addrMapIndex, sysNum, blockPath,
   * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex
   */
  { 7, 0, "rtwdemo_capi/Out1",
    "", 1, 0, 0, 0, 0 },

  { 8, 0, "rtwdemo_capi/Out2",
    "", 2, 0, 0, 0, 0 },

  { 9, 0, "rtwdemo_capi/Out3",
    "", 3, 0, 0, 0, 0 },

  { 10, 0, "rtwdemo_capi/Out4",
    "", 4, 0, 0, 0, 0 },

  { 11, 0, "rtwdemo_capi/Out5",
    "sig2_eg", 5, 0, 1, 0, 0 },

  { 12, 0, "rtwdemo_capi/Out6",
    "", 6, 0, 1, 0, 0 },

  {
    0, 0, (NULL), (NULL), 0, 0, 0, 0, 0
  }
};

For information about interpreting the values in the rtwCAPI_Signals structure, see the previous
section “C API Signals” on page 60-8.

C API Parameters

The rtwCAPI_BlockParameters and rtwCAPI_ModelParameters structures capture parameter
information including the parameter name, block path (for block parameters), address, data type
information, dimensions information, and fixed-point information.

The rtModelParameters array contains entries for workspace variables that are referenced as
tunable Simulink block parameters or Stateflow data of machine scope. For example, tunable
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parameters include Simulink.Parameter objects that use a storage class other than Auto. The
Simulink Coder software assigns its elements only NULL or zero values in the absence of such data.

The setting that you select for the model configuration parameter Default parameter behavior
determines how information is generated into the rtBlockParameters array in model_capi.c
(or .cpp).

• If you set Default parameter behavior to Tunable, the rtBlockParameters array contains an
entry for every modifiable parameter of every block in the model. However, if you use a MATLAB
variable or a tunable parameter to specify a block parameter, the block parameter does not appear
in rtBlockParameters. Instead, the variable or tunable parameter appears in
rtModelParameters.

• If you set Default parameter behavior to Inlined, the rtBlockParameters array is empty.
The Simulink Coder software assigns its elements only NULL or zero values.

The last member of each array is a sentinel, with all elements set to null values.

Here is the rtBlockParameters array that is generated by default in rtwdemo_capi_capi.c:
/* Individual block tuning is not valid when inline parameters is *
 * selected. An empty map is produced to provide a consistent     *
 * interface independent  of inlining parameters.                 *
 */
static const rtwCAPI_BlockParameters rtBlockParameters[] = {
  /* addrMapIndex, blockPath,
   * paramName, dataTypeIndex, dimIndex, fixPtIdx
   */
  {
    0, (NULL), (NULL), 0, 0, 0
  }
};

In this example, only the final, sentinel array element is generated, with all members of the structure
rtwCAPI_BlockParameters set to NULL and zero values. This is because Default parameter
behavior is set to Inlined by default for the rtwdemo_capi example model. If you set Default
parameter behavior to Tunable, the block parameters are generated in the
rtwCAPI_BlockParameters structure. However, MATLAB variables and tunable parameters appear
in the rtwCAPI_ModelParameters structure.

Here is the rtModelParameters array that is generated by default in rtwdemo_capi_capi.c:
/* Tunable variable parameters */
static const rtwCAPI_ModelParameters rtModelParameters[] = {
  /* addrMapIndex, varName, dataTypeIndex, dimIndex, fixPtIndex */
  { 2, TARGET_STRING("Ki"), 0, 0, 0 },

  { 3, TARGET_STRING("Kp"), 0, 0, 0 },

  { 4, TARGET_STRING("p1"), 0, 2, 0 },

  { 5, TARGET_STRING("p2"), 0, 3, 0 },

  { 6, TARGET_STRING("p3"), 0, 4, 0 },

  { 0, (NULL), 0, 0, 0 }
};

In this example, the rtModelParameters array contains entries for each variable that is referenced
as a tunable Simulink block parameter.

For example, the varName (variable name) of the fourth parameter is p2. The other fields correspond
to the like-named signal equivalents described in “C API Signals” on page 60-8, as follows:
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• The address of the fourth parameter is given by addrMapIndex, which, in this example, is 5. This
is an index into the rtDataAddrMap array, found later in rtwdemo_capi_capi.c. Because the
index is zero based, 5 corresponds to the sixth element in rtDataAddrMap, which is rtP_p2.

• The dataTypeIndex provides an index into the rtDataTypeMap array, found later in
rtwdemo_capi_capi.c, indicating the data type of the parameter. The value 0 corresponds to a
double, noncomplex parameter.

• The dimIndex (dimensions index) provides an index into the rtDimensionMap array, found later
in rtwdemo_capi_capi.c. The value 3 corresponds to the fourth entry, which is
{ rtwCAPI_MATRIX_COL_MAJOR, 6, 2, 0 }.

• The fixPtIndex (fixed-point index) provides an index into the rtFixPtMap array, found later in
rtwdemo_capi_capi.c, indicating fixed-point information about the parameter. As with the
corresponding signal attribute, a fixed-point map index of zero means that the parameter does not
have fixed-point information.

For more information about tunable parameter storage in the generated code, see “How Generated
Code Stores Internal Signal, State, and Parameter Data” on page 34-49.

Map C API Data Structures to rtModel

The real-time model data structure encapsulates model data and associated information that
describes the model fully. When you select the C API feature and generate code, the Simulink Coder
code generator adds another member to the real-time model data structure generated in model.h:

/*
 * DataMapInfo:
 * The following substructure contains information regarding
 * structures generated in the model's C API.
 */
struct {
  rtwCAPI_ModelMappingInfo mmi;
} DataMapInfo;

This member defines mmi (for model mapping information) of type struct
rtwCAPI_ModelMappingInfo. The structure is located in matlabroot/rtw/c/src/
rtw_modelmap.h. The mmi substructure defines the interface between the model and the C API files.
More specifically, members of mmi map the real-time model data structure to the structures in
model_capi.c (or .cpp).

Initializing values of mmi members to the arrays accomplishes the mapping, as shown in “Map Model
to C API Arrays of Structures” on page 60-15. Each member points to one of the arrays of structures
in the generated C API file. For example, the address of the rtBlockSignals array of structures is
allocated to the first member of the mmi substructure in model.c (or .cpp), using the following code
in the rtw_modelmap.h file:

/* signals */
struct {
    rtwCAPI_Signals const *signals;     /* Signals Array */
    uint_T                numSignals;   /* Num Signals   */
    rtwCAPI_Signals const *rootInputs;  /* Root Inputs array */
    uint_T               numRootInputs; /* Num Root Inputs  */
    rtwCAPI_Signals const *rootOutputs; /* Root Outputs array */
    uint_T               numRootOutputs;/* Num Root Outputs  */
} Signals;
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The model initialize function in model.c (or .cpp) performs the initializing by calling the C API
initialize function. For example, the following code is generated in the model initialize function for
example model rtwdemo_capi:
/* Initialize DataMapInfo substructure containing ModelMap for C API */
rtwdemo_capi_InitializeDataMapInfo(rtwdemo_capi_M);

Map Model to C API Arrays of Structures

Note This figure lists the arrays in the order that their structures appear in rtw_modelmap.h,
which differs slightly from their generated order in model_capi.c.

Generate C API Data Definition File for Exchanging Data with a Target
System
This example shows how to use the target-based C API to interface with generated code that
represents signals, states, parameters, and root-level I/O.

Open Example Model

Open the example model rtwdemo_capi.

open_system('rtwdemo_capi');

The C API is useful for interacting with application data in generated code, without stopping program
execution or recompiling the generated code. To use the C API interface, for a top model and its
referenced models:
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1. Set up a client/server protocol (such as TCP/IP or a dual-port memory connection) between your
development computer and the target computer.

2. Select at least one of the C API model configuration parameters: signals, parameters, states, and
root-level I/O.

3. Configure the data elements that you want to access with the C API with addressable storage
classes.

C API configuration settings for the top model and referenced models must match.

The code generator places the C API interface in the file model_capi.c. Depending on your
configuration settings, the data can represent signals, states, parameters, and root-level I/O
configured with addressable storage classes. The file includes structures that provide an interface to
data properties.

C API Limitations
The C API feature has the following limitations.

• The C API does not support the following values for the CodeFormat TLC variable:

• S-Function
• Accelerator_S-Function (for accelerated simulation)

• For ERT-based targets, the C API requires that support for floating-point code be enabled.
• Local block output signals are not supported.
• Local Stateflow parameters are not supported.
• The following custom storage class objects are not supported:

• Objects without the package csc_registration file
• Grouped custom storage classes
• Objects defined by using macros
• BitField objects
• FileScope objects

• Customized data placement is disabled when you are using the C API. The interface looks for
global data declaration in model.h and model_private.h. Declarations placed in any other file
by customized data placement result in code that does not compile.

Note Custom Storage Class objects work in code generation, only if you use the ERT system target
file and clear the model configuration parameter Ignore custom storage classes.

See Also

Related Examples
• “Access Signal, State, and Parameter Data During Execution”
• “How Generated Code Exchanges Data with an Environment”
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• “How Generated Code Stores Internal Signal, State, and Parameter Data”

 Exchange Data Between Generated and External Code Using C API

60-17



Use C API to Access Model Signals and States
This example helps you get started writing application code to interact with model signals and states.
To get started writing application code to interact with model parameters, see “Use C API to Access
Model Parameters” on page 60-23.

The C API provides you with the flexibility of writing your own application code to interact with model
signals, states, root-level inputs/outputs, and parameters. Your target-based application code is
compiled with the Simulink Coder generated code into an executable. The target-based application
code accesses the C API structure arrays in model_capi.c (or .cpp). You might have host-based
code that interacts with your target-based application code. Or, you might have other target-based
code that interacts with your target-based application code. The files rtw_modelmap.h and
rtw_capi.h, located in matlabroot/rtw/c/src (open), provide macros for accessing the
structures in these arrays and their members.

Here is an example application that logs global signals and states in a model to a text file. This code is
intended as a starting point for accessing signal and state addresses. You can extend the code to
perform signal logging and monitoring, state logging and monitoring, or both.

This example uses the following macro and function interfaces:

• rtmGetDataMapInfo macro

Accesses the model mapping information (MMI) substructure of the real-time model structure. In
the following macro call, rtM is the pointer to the real-time model structure in model.c
(or .cpp):
rtwCAPI_ModelMappingInfo* mmi = &(rtmGetDataMapInfo(rtM).mmi);

• rtmGetTPtr macro

Accesses the absolute time information for the base rate from the timing substructure of the real-
time model structure. In the following macro call, rtM is the pointer to the real-time model
structure in model.c (or .cpp):
rtmGetTPtr(rtM)

• Custom functions capi_StartLogging, capi_UpdateLogging, and
capi_TerminateLogging, provided via the files rtwdemo_capi_datalog.h and
rtwdemo_capi_datalog.c. These files are located in matlabroot/toolbox/rtw/rtwdemos
(open).

• capi_StartLogging initializes signal and state logging.
• capi_UpdateLogging logs a signal and state value at each time step.
• capi_TerminateLogging terminates signal and state logging and writes the logged values to

a text file.

You can integrate these custom functions into generated code for a model by using these methods:

• Custom Code of the Model Configuration Parameters dialog box.
• Custom Code library blocks
• TLC custom code functions

This tutorial uses the Custom Code pane of the Model Configuration Parameters dialog box and
the System Outputs block from the Custom Code library to insert calls to the custom functions
into model.c (or .cpp), as follows:
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• capi_StartLogging is called in the model_initialize function.
• capi_UpdateLogging is called in the model_step function.
• capi_TerminateLogging is called in the model_terminate function.

The following excerpts of generated code from model.c (rearranged to reflect their order of
execution) show how the function interfaces are used.
void rtwdemo_capi_initialize(void)
{
...
  /* user code (Initialize function Body) */

  /* C API Custom Logging Function: Start Signal and State logging via C API.
   * capi_StartLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    printf("** Started state/signal logging via C API **\n");
    capi_StartLogging(MMI, MAX_DATA_POINTS);
  }
...
}
...
/* Model step function */
void rtwdemo_capi_step(void)
{
...
  /* user code (Output function Trailer) */

  /* System '<Root>' */

  /* C API Custom Logging Function: Update Signal and State logging buffers.
   * capi_UpdateLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    capi_UpdateLogging(MMI, rtmGetTPtr(rtwdemo_capi_M));
  }
...
}
...
/* Model terminate function */
void rtwdemo_capi_terminate(void)
{
  /* user code (Terminate function Body) */

  /* C API Custom Logging Function: Dump Signal and State buffers into a text file.
   * capi_TerminateLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
    capi_TerminateLogging("rtwdemo_capi_ModelLog.txt");
    printf("** Finished state/signal logging. Created rtwdemo_capi_ModelLog.txt **\n");
  }
}

The following procedure illustrates how you can use the C API macro and function interfaces to log
global signals and states in a model to a text file.

1 At the MATLAB command line, enter rtwdemo_capi to open the example model.
2 Save the top model rtwdemo_capi and the referenced model rtwdemo_capi_bot to the same

writable work folder.
3 Open the Configuration Parameters dialog box.
4 If you are licensed for Embedded Coder software and you want to use the ert.tlc system target

file instead of the default grt.tlc, change the setting of model configuration parameter System
target file. Make sure that you also select ert.tlc for the referenced model
rtwdemo_capi_bot.

5 For the top model, confirm these model configuration parameter settings:
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a Select parameters Generate C API for signals, Generate C API for states, and Generate
C API for parameters.

b If you are using the ert.tlc system target file, select Support complex numbers
c Select MAT-file logging.
d Click Apply.
e Update configuration parameter settings in the referenced model, rtwdemo_capi_bot, to

match changes you made in the top model.
6 Use the Custom Code pane to embed your custom application code in the generated code.

Select the Custom Code pane, and then click Include directories. The Include directories
input field is displayed.

7 In the Include directories field, type matlabroot/toolbox/rtw/rtwdemos, where
matlabroot represents the root of your MATLAB installation folder. (If you are specifying a
Windows path that contains a space, place the text inside double quotes.)

8 In the Additional Build Information subpane, click Source files, and type
rtwdemo_capi_datalog.c.

9 In the Include custom C code in generated subpane, click Source file, and type or copy and
paste the following include statement:
#include "rtwdemo_capi_datalog.h"

10 In the Initialize function field, type or copy and paste the following application code:
  /* C API Custom Logging Function: Start Signal and State logging via C API.
   * capi_StartLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    printf("** Started state/signal logging via C API **\n");
    capi_StartLogging(MMI, MAX_DATA_POINTS);
  }

Note If you renamed the top model rtwdemo_capi, update the name rtwdemo_capi_M in the
application code to reflect the new model name.

11 In the Terminate function field, type or copy and paste the following application code:
  /* C API Custom Logging Function: Dump Signal and State buffers into a text file.
   * capi_TerminateLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
capi_TerminateLogging("rtwdemo_capi_ModelLog.txt");
printf("** Finished state/signal logging. Created rtwdemo_capi_ModelLog.txt **\n");
  }

Click Apply.
12 In the MATLAB Command Window, enter custcode to open the Simulink Coder Custom Code

library. At the top level of the rtwdemo_capi model, add a System Outputs block.
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13 Double-click the System Outputs block to open the System Outputs Function Custom Code dialog
box. In the System Outputs Function Exit Code field, type or copy and paste the following
application code:
  /* C API Custom Logging Function: Update Signal and State logging buffers.
   * capi_UpdateLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    capi_UpdateLogging(MMI, rtmGetTPtr(rtwdemo_capi_M));
  }

If you renamed the top model rtwdemo_capi, update two instances of the name
rtwdemo_capi_M in the application code to reflect the new model name.

Click OK.
14 Clear model configuration parameter Generate code only.

Build the model and generate an executable program. For example, on a Windows system, the
build generates the executable file rtwdemo_capi.exe in your current working folder.

15 In the MATLAB Command Window, enter the command !rtwdemo_capi to run the executable
file. During execution, signals and states are logged using the C API and then written to the text
file rtwdemo_capi_ModelLog.txt in your current working folder.
>> !rtwdemo_capi

** starting the model **
** Started state/signal logging via C API **
** Logging 2 signal(s) and 1 state(s). In this demo, only scalar named
 signals/states are logged **
** Finished state/signal logging. Created rtwdemo_capi_ModelLog.txt **

16 Examine the text file in the MATLAB editor or other text editor. Here is an excerpt of the signal
and state logging output.
******** Signal Log File ********

Number of Signals Logged: 2
Number of points (time steps) logged: 51

Time           bot_sig1 (Referenced Model)             top_sig1
0              70                                      4
0.2            70                                      4
0.4            70                                      4
0.6            70                                      4
0.8            70                                      4
1              70                                      4
1.2            70                                      4
1.4            70                                      4
1.6            70                                      4
1.8            70                                      4
2              70                                      4
...

******** State Log File ********

Number of States Logged: 1
Number of points (time steps) logged: 51

Time           bot_state (Referenced Model)
0              0
0.2            70
0.4            35
0.6            52.5
0.8            43.75
1              48.13
1.2            45.94
1.4            47.03
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1.6            46.48
1.8            46.76
2              46.62
...

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Use C API to Access Model Parameters
This example helps you get started writing application code to interact with model parameters. To get
started writing application code to interact with model signals and states, see “Use C API to Access
Model Signals and States” on page 60-18.

The C API provides you with the flexibility of writing your own application code to interact with model
signals, states, root-level inputs/outputs, and parameters. Your target-based application code is
compiled with generated code into an executable program. The target-based application code
accesses the C API structure arrays in model_capi.c (or .cpp). You might have host-based code
that interacts with your target-based application code. Or, you might have other target-based code
that interacts with your target-based application code. The files rtw_modelmap.h and rtw_capi.h,
located in matlabroot/rtw/c/src (open), provide macros for accessing the structures in these
arrays and their members.

Here is an example application that prints the parameter values of tunable parameters in a model to
the standard output. This code is intended as a starting point for accessing parameter addresses. You
can extend the code to perform parameter tuning. The application:

• Uses the rtmGetDataMapInfo macro to access the mapping information in the mmi substructure
of the real-time model structure

rtwCAPI_ModelMappingInfo* mmi = &(rtmGetDataMapInfo(rtM).mmi);

where rtM is the pointer to the real-time model structure in model.c (or .cpp).
• Uses rtwCAPI_GetNumModelParameters to get the number of model parameters in mapped C

API:

uint_T nModelParams = rtwCAPI_GetNumModelParameters(mmi);
• Uses rtwCAPI_GetModelParameters to access the array of model parameter structures

mapped in C API:

rtwCAPI_ModelParameters* capiModelParams = \
 rtwCAPI_GetModelParameters(mmi);

• Loops over the capiModelParams array to access individual parameter structures. A call to the
function capi_PrintModelParameter displays the value of the parameter.

The example application code is provided below:

{
/* Get CAPI Mapping structure from Real-Time Model structure */
rtwCAPI_ModelMappingInfo* capiMap = \
&(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);

/* Get number of Model Parameters from capiMap */
uint_T nModelParams = rtwCAPI_GetNumModelParameters(capiMap);
printf("Number of Model Parameters: %d\n", nModelParams);

/* If the model has Model Parameters, print them using the
application capi_PrintModelParameter */
if (nModelParams == 0) {
   printf("No Tunable Model Parameters in the model \n");
}
else {
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   unsigned int idx;

   for (idx=0; idx < nModelParams; idx++) {
      /* call print utility function */
      capi_PrintModelParameter(capiMap, idx);
   }
}
}

The print utility function is located in matlabroot/rtw/c/src/rtw_capi_examples.c. This file
contains utility functions for accessing the C API structures.

To become familiar with the example code, try building a model that displays the tunable block
parameters and MATLAB variables. You can use rtwdemo_capi, the C API example model. The
following steps apply to both grt.tlc and ert.tlc system target files, unless otherwise indicated.

1 At the MATLAB command line, enter rtwdemo_capi to open the example model.
2 Save the top model rtwdemo_capi and the referenced model rtwdemo_capi_bot to the same

writable work folder.
3 If you are licensed for Embedded Coder software and you want to use the ert.tlc system target

tile instead of the default grt.tlc, use model configuration parameter System target file to
select an ert.tlc system target file. Make sure that you also select ert.tlc for the referenced
model rtwdemo_capi_bot.

4 Confirm these model configuration parameter settings:

a Select Generate C API for parameters.
b If you are using the ert.tlc system target file, select Support complex numbers.
c Select MAT-file logging.
d Click Apply.
e Update configuration parameter settings in the referenced model, rtwdemo_capi_bot, to

match changes you made in the top model.
5 Use the Custom Code pane to embed your custom application code in the generated code.

Select the Custom Code pane, and then click Initialize function. The Initialize function input
field is displayed.

6 In the Initialize function input field, type or copy and paste the example application code
shown above step 1. This embeds the application code in the model_initialize function.

Note If you renamed the top model rtwdemo_capi, update the name rtwdemo_capi_M in the
application code to reflect the new model name.

7 Click Include directories, and type matlabroot/rtw/c/src, where matlabroot represents
the root of your MATLAB installation folder. (If you are specifying a Windows path that contains a
space, place the text inside double quotes.)

8 In the Additional Build Information subpane, click Source files, and type
rtw_capi_examples.c.
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Click Apply.
9 Clear model configuration parameter Generate code only.

Build the model and generate an executable program. For example, on a Windows system, the
build generates the executable file rtwdemo_capi.exe in your current working folder.

10 In the MATLAB Command Window, enter !rtwdemo_capi to run the executable file. Running
the program displays parameter information in the Command Window.

>> !rtwdemo_capi

** starting the model **
Number of Model Parameters: 5
Ki =
    7
Kp =
    4
p1 =
    0.15
    0.36
    0.81
p2 =
    0.09    0.75    0.57
    0.13    0.96    0.059
p3 =
ans(:,:,1) =
    0.23    0.82    0.04    0.64
    0.35    0.01    0.16    0.73

ans(:,:,2) =
    0.64    0.54    0.74    0.68
    0.45    0.29    0.18    0.18
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See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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ASAP2 Data Measurement and
Calibration in Simulink Coder

• “Export ASAP2 File for Data Measurement and Calibration” on page 61-2
• “Calibrate Generated Code and Monitor Signals” on page 61-10
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Export ASAP2 File for Data Measurement and Calibration
The ASAM MCD-2 MC standard, also known as ASAP2, is a data definition standard proposed by the
Association for Standardization of Automation and Measuring Systems (ASAM). ASAP2 is a non-
object-oriented description of the data used for measurement, calibration, and diagnostic systems.
For more information on ASAM and the ASAM MCD-2 MC (ASAP2) standard, see the ASAM website
at www.asam.net.

The code generator enables you to export an ASAP2 file containing information about your model
during the code generation process.

You can run an interactive example of ASAP2 file generation. To open the example at the MATLAB
command prompt, enter:

rtwdemo_asap

Simulink Coder support for ASAP2 file generation is version-neutral. By default, the software
generates ASAP2 version 1.31 format, but the generated model information is generally compatible
with other ASAP2 versions. ASAP2 file generation is also neutral with respect to the specific needs of
ASAP2 measurement and calibration tools. The software provides customization APIs that you can
use to customize ASAP2 file generation to generate an ASAP2 version and to meet the specific needs
of your ASAP2 tools.

In this section...
“What You Should Know” on page 61-2
“System Target Files Supporting ASAP2” on page 61-2
“Define ASAP2 Information” on page 61-3
“Generate an ASAP2 File” on page 61-6
“Structure of ASAP2 File” on page 61-8
“Create a Host-Based ASAM-ASAP2 Data Definition File for Data Measurement and Calibration” on
page 61-8

What You Should Know
To make use of ASAP2 file generation, you should become familiar with:

• ASAM and the ASAP2 standard and terminology. See the ASAM Web site at www.asam.net.
• Configuring model data elements for code generation. See Code Mappings editor.
• Storage and representation of signals and parameters in generated code. See “Data Access for

Prototyping and Debugging”.
• If you have Embedded Coder, see “Data Representation and Access”.

System Target Files Supporting ASAP2
You can use ASAP2 file generation with varying system target file configurations. For example, GRT-
and ERT- based configurations enables you to generate an ASAP2 file as part of the code generation
and build process.
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For procedures for generating ASAP2 files by using the system target file configurations, see
“Generate an ASAP2 File” on page 61-6.

Define ASAP2 Information
• “Define ASAP2 Information for Parameters and Signals” on page 61-3
• “Memory Address Attribute” on page 61-3
• “Automatic ECU Address Replacement for ASAP2 Files (Embedded Coder)” on page 61-4
• “Define ASAP2 Information for Lookup Tables” on page 61-5

Define ASAP2 Information for Parameters and Signals

The ASAP2 file generation process requires information about parameters and signals in your model.
Some of this information is contained in the model itself. Use Simulink data objects in a workspace or
data dictionary to complete the ASAP2 file generation process. In some cases, the use of workspace
objects is optional.

Use the Model Data Editor and built-in Simulink data objects to provide information, such as using
Simulink.Signal objects to provide MEASUREMENT information and Simulink.Parameter
objects to provide CHARACTERISTIC information. You can use data objects from data classes that are
derived from Simulink.Signal and Simulink.Parameter to provide the information. See “Data
Objects” and “Configure Data Properties by Using the Model Data Editor”.

This table contains the minimum set of data attributes required for ASAP2 file generation. Some data
attributes are defined in the model. Others attributes are supplied in the properties of objects. For
attributes that are defined in Simulink.Signal or Simulink.Parameter objects, the table lists
the associated property name.

Data Attribute Defined In Property Name
Name (symbol) Model and data object Inherited from the handle of the

data object to which parameter or
signal name resolves

Description Data object Description
Data type Model or data object DataType
Scaling
(if fixed-point data type)

Model or data object DataType

Minimum allowable value Model or data object Min
Maximum allowable value Model or data object Max
Unit Model or data object Unit
Memory address (optional) Model or data object MemoryAddress_ASAP2

(optional; see “Memory Address
Attribute” on page 61-3.)

Memory Address Attribute

If the memory address attribute is unknown before code generation, the code generator inserts ECU
Address placeholder text in the generated ASAP2 file. You can substitute an actual address for the
placeholder by postprocessing the generated file. For an example, see the file matlabroot/
toolbox/rtw/targets/asap2/asap2/asap2post.m. asap2post.m parses through the linker
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map file that you provide and replaces the ECU Address placeholders in the ASAP2 file with the
actual memory addresses. Because linker map files vary from compiler to compiler, you might need to
modify the regular expression code in asap2post.m to match the format of the linker map that you
use.

If you have Embedded Coder installed on your system, and if you are generating Executable and
Linkable Format (ELF) or Program Database (PDB) files for your embedded target, you can use the
rtw.asap2SetAddress function to automate ECU address replacement. For more information, see
“Automatic ECU Address Replacement for ASAP2 Files (Embedded Coder)” on page 61-4.

If the memory address attribute is known before code generation, it can be defined in the data item
or data object. By default, the MemoryAddress_ASAP2 property does not exist in the
Simulink.Signal or Simulink.Parameter data object classes. If you want to add the attribute,
add a property called MemoryAddress_ASAP2 to a custom class that is a subclass of the Simulink
or ASAP2 class. For information on subclassing Simulink data classes, see “Define Data Classes”.

This table indicates the Simulink object properties that have replaced the ASAP2 object properties of
the previous release.

Differences Between ASAP2 and Simulink Parameter and Signal Object Properties

ASAP2 Object Properties (Previous) Simulink Object Properties (Current)
LONGID_ASAP2 Description
PhysicalMin_ASAP2 Min
PhysicalMax_ASAP2 Max
Units_ASAP2 Unit

Automatic ECU Address Replacement for ASAP2 Files (Embedded Coder)

If you have Embedded Coder installed on your system, and if you are generating Executable and
Linkable Format (ELF) or Program Database (PDB) files for your embedded target, you can use the
rtw.asap2SetAddress function to automate the replacement of ECU Address placeholder memory
address values with actual addresses in the generated ASAP2 file.

If the memory address attribute is unknown before code generation, the code generator inserts ECU
Address placeholder text in the generated ASAP2 file, as shown

/begin CHARACTERISTIC
  /* Name            */ Ki
  /* Long Identifier */ ""
  /* Type            */ VALUE
  /* ECU Address     */ 0x0000 /* @ECU_Address@Ki@ */

To substitute actual addresses for the ECU Address placeholders, process the generated ASAP2 file
by using the rtw.asap2SetAddress function. The syntax is:

rtw.asap2SetAddress(ASAP2File,InfoFile)

The arguments are character vectors specifying the name of the generated ASAP2 file and the name
of the generated executable ELF file, PDB file from Microsoft toolchain, or DWARF debug information
files for the model. When called, rtw.asap2SetAddress extracts the actual ECU address from the
specified ELF, PDB, or DWARF file and replaces the placeholder in the ASAP2 file with the actual
address, for example:
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/begin CHARACTERISTIC
  /* Name            */ Ki
  /* Long Identifier */ ""
  /* Type            */ VALUE
  /* ECU Address     */ 0x40009E60

Define ASAP2 Information for Lookup Tables

Simulink Coder software generates ASAP2 descriptions for lookup table data and its breakpoints. The
software represents 1-D table data as CURVE information, 2-D table data as MAP information, and
breakpoints as AXIS_DESCR and AXIS_PTS information. You can model lookup tables by using one of
the following Simulink Lookup Table blocks:

• Direct Lookup Table (n-D) — 1 and 2 dimensions
• Interpolation Using Prelookup — 1 and 2 dimensions
• 1–D Lookup Table
• 2–D Lookup Table
• n-D Lookup Table — 1 and 2 dimensions

The software supports these types of lookup table breakpoints (axis points).

Breakpoint Type Information Generated
Tunable and shared among
multiple table axes (common
axis)

COM_AXIS

Fixed and nontunable (fixed
axis)

One of these variants of FIX_AXIS:

• FIX_AXIS_PAR if breakpoints are integers with equidistant
spacing and the equidistant spacing is a power of two

• FIX_AXIS_PAR_DIST if breakpoints are integers with
equidistant spacing

• FIX_AXIS_PAR_LIST if breakpoints are integers with non-
equidistant spacing

Tunable but not shared among
multiple tables (standard axis)

STD_AXIS

When you configure the blocks for ASAP2 code generation:

• For table data, use a Simulink.Parameter data object with a non-Auto storage class.
• For tunable breakpoint data that is shared among multiple table axes (COM_AXIS), use a

Simulink.Parameter data object that has a non-Auto storage class.
• For fixed, nontunable breakpoint data (FIX_AXIS), use workspace variables or arrays specified in

the block parameters dialog box. The breakpoints must be stored as integers in the code. The data
type must be a built-in integer type (int8, int16, int32, uint8, uint16, or uint32), a fixed-
point data type, or an equivalent alias type.

• For tunable breakpoint data that is not shared among multiple tables (STD_AXIS):

1 Create a Simulink.Bus object to define the struct packaging (names and order of the
fields). The fields of the parameter structure must correspond to the lookup table data and
each axis of the lookup table block. For example, in an n-D Lookup Table block that has 2
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dimensions, the structure must contain only three fields. This bus object describes the record
layout for the lookup characteristic.

2 Create a Simulink.Parameter object to represent a tunable parameter.
3 Create table and axis values.
4 Optionally, specify the Units, Minimum, and Maximum properties for the parameter object.

Here is an example of an n-D Lookup Table record generated into an ASAP2 file in Standard Axis
format:

/begin CHARACTERISTIC
  /* Name */  STDAxisParam
  ...
  /* Record Layout */   Lookup1D_X_WORD_Y_FLOAT32_IEEE
  ...
  begin AXIS_DESCR
    /* Description of X-Axis Points */
    /* Axis Type */      STD_AXIS
    ...
  /end AXIS_DESCR
/end CHARACTERISTIC

/begin RECORD_LAYOUT Lookup1D_X_WORD_Y_FLOAT32_IEEE
  AXIS_PTS_X 1 WORD INDEX_INCR DIRECT
  FNC_VALUES 2 FLOAT32_IEEE COLUMN_DIR DIRECT
/end   RECORD_LAYOUT

Note The example model rtwdemo_asap2 shows ASAP2 file generation for Lookup Table blocks,
including both tunable (COM_AXIS) and fixed (FIX_AXIS) lookup table breakpoints.

Generate an ASAP2 File
• “Generating ASAP2 Files” on page 61-6
• “Use GRT- or ERT- Based System Target File” on page 61-6
• “Generate ASAP2 Files for Referenced Models” on page 61-7
• “Merge ASAP2 Files for Top and Referenced Models” on page 61-7

Generating ASAP2 Files

Use the Generic Real-Time system target file or a Embedded Coder system target file to generate an
ASAP2 file as part of the code generation and build process.

Generate ASAP2 file by using the system target files that have built-in ASAP2 support. For an
example, see the ASAP2 example model rtwdemo_asap2.

Use GRT- or ERT- Based System Target File

To generate the ASAP2 data definition for a model by using a Generic Real-Time(GRT) system target
file or Embedded Coder system target file:

1 Use the Code Mappings editor to apply storage classes to signals, block states, and model
parameters, as described in “C Code Generation Configuration for Model Interface Elements” on
page 33-2.
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Parameters are not represented in the ASAP2 file if one or more of the following conditions exist:

• You apply storage class Auto, FileScope, Struct, or Default (through Model default).
• You apply storage class through Embedded Coder Dictionary.
• You apply a storage class that causes the code generator to generate a macro or non-

addressable variable.
2 Use the Property Inspector to configure the remaining storage class properties for each data

element.
3 Set the model configuration parameter System target file to a GRT- or ERT- based system target

file.
4 Select model configuration parameter ASAP2 interface.
5 Select parameter Generate code only.
6 Click Apply.
7 Generate code.

The code generator writes the ASAP2 file to the build folder. By default, the file is named
model.a2l, where model is the name of the model. The ASAP2 setup file controls the ASAP2 file
name. For details, see “Customize Generated ASAP2 File” on page 84-2.

Generate ASAP2 Files for Referenced Models

The build process can generate an ASAP2 file for each referenced model in a model reference
hierarchy. In the generated ASAP2 file, MEASUREMENT records represent signals and states inside
the referenced model.

To generate ASAP2 files for referenced models, select ASAP2 file generation for the top model and for
each referenced model in the reference hierarchy. If you are using the Generic Real-Time Target or an
Embedded Coder target, follow the procedure described in “Use GRT- or ERT- Based System Target
File” on page 61-6 for the top model and each referenced model.

Merge ASAP2 Files for Top and Referenced Models

Use function rtw.asap2MergeMdlRefs to merge the ASAP2 files generated for top and referenced
models. The function has this syntax:

[status,info] = rtw.asap2MergeMdlRefs(topModelName,asap2FileName)

• topModelName is the name of the model containing one or more referenced models.
• asap2FileName is the name that you specify for the merged ASAP2 file.
• Optional: status returns false (logical 0) if the merge completed and returns true (logical 1)

otherwise.
• Optional: info returns additional information about merge failure if status is true. Otherwise, it

returns an empty character vector.

Consider the following example.

[status,info] = rtw.asap2MergeMdlRefs('myTopMdl','merged.a2l')

This command merges the ASAP2 files generated for the top model myTopMdl and its referenced
models in the file merged.a2l.

The example model rtwdemo_asap2 includes an example of merging ASAP2 files.
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Structure of ASAP2 File
This table outlines the basic structure of the ASAP2 file and describes the Target Language Compiler
(TLC) functions and files used to create each part of the file:

• Static parts of the ASAP2 file are shown in bold.
• Function calls are indicated by %<FunctionName()>.

File Section Contents of asap2main.tlc TLC File Containing
Function Definition

File header %<ASAP2UserFcnWriteFileHead()> asap2userlib.tlc
/begin PROJECT "" /begin PROJECT "%<ASAP2ProjectName>" asap2setup.tlc
/begin HEADER ""
HEADER contents

/begin HEADER"%<ASAP2HeaderName>"
%<ASAP2UserFcnWriteHeader()>

asap2setup.tlc
asap2userlib.tlc

/end HEADER /end HEADER asap2userlib.tlc
/begin MODULE ""
MODULE contents:

/begin MODULE "%<ASAP2ModuleName>"} asap2setup.tlc
asap2userlib.tlc

- A2ML
- MOD_PAR
- MOD_COMMON
...

%<ASAP2UserFcnWriteHardwareInterface()> asap2userlib.tlc

Model-dependent MODULE
contents:

%<SLibASAP2WriteDynamicContents()>
Calls user-defined functions:

asap2lib.tlc

- RECORD_LAYOUT
- CHARACTERISTIC
- ParameterGroups
- ModelParameters

...WriteRecordLayout_TemplateName()
  ...WriteCharacteristic_TemplateName()
  ...WriteCharacteristic_Scalar()

user/templates/...

- MEASUREMENT
- ExternalInputs
- BlockOutputs

...WriteMeasurement() asap2userlib.tlc

- COMPU_METHOD ...WriteCompuMethod() asap2userlib.tlc
/end MODULE /end MODULE  
File footer/tail %<ASAP2UserFcnWriteFileTail()> asap2userlib.tlc

Create a Host-Based ASAM-ASAP2 Data Definition File for Data
Measurement and Calibration
This model shows ASAP2 data export. ASAP2 is a data definition standard proposed by the
Association for Standardization of Automation and Measuring Systems (ASAM).

Open Example Model

Open the example model rtwdemo_asap2.

open_system('rtwdemo_asap2');
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ASAP2 is a non-object-oriented description of the data used for measurement, calibration, and
diagnostics systems. For more information on ASAM and the ASAP2 standard, see the ASAM Web
site: https://www.asam.net.

ASAP2 data definition is achieved with Simulink® data objects and test point signals. Using the
Target Language Compiler (TLC), you can create highly customized solutions for your application.
See the Simulink Coder® documentation for details on ASAP2 file generation.

You can configure ASAP2 file generation by selecting ASAP2 interface on the Code Generation >
Interface pane of the Configuration Parameters dialog box.

See Also

Related Examples
• “Create Tunable Calibration Parameter in the Generated Code” on page 34-109
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Calibrate Generated Code and Monitor Signals
When you create an external mode target application that uses an ASAM MCD-1 XCP communication
channel, you can also generate an ASAP2 file that provides a description of the Simulink Coder
Universal Measurement and Calibration Protocol (XCP) slave configuration. The description enables
third-party calibration tools, such as ETAS® INCA and Vector CANape®, to connect to the external
mode target application. You can use the third-party tools to calibrate generated code and monitor
signals in environments supported by the third-party tools, for example, a vehicle, a test bench, or a
virtual environment on a PC.

Configure your model to generate an ASAP2 file that provides a description of the XCP slave
configuration:

1 On the Apps tab, click Run on Custom Hardware, which displays the Hardware tab.
2 In the Hardware section, in the System Target File Description field, select Embedded Coder

(ert.tlc).
3 In the Prepare section, click Hardware Settings, which opens the Configuration Parameters

dialog box.
4 Clear Generate code only.
5 Specify Toolchain settings for your development computer.
6 Select External mode.
7 Set Transport layer to XCP on TCP/IP or XCP on Serial.
8 For Mex-file arguments, specify the required arguments. For example:

• For XCP on TCP/IP, specify the IP address of the target processor and the port number of
the TCP/IP server.

• For XCP on Serial, specify the serial port ID and the baud value.
9 Click OK.

To generate the target application and the ASAP2 file:

1 On the Hardware tab, in the Run on Hardware section, click Monitor & Tune.
2 Under Step By Step Commands, click Build for Monitoring.
3 Use Generate Calibration Files tool to generate the ASAP2 file. Or generate the file by using

this command:

coder.asap2.export('modelName','MapFile','symbolFileName');
4 In the code generation folder, the build process generates the XCP external mode target

application modelName.exe and the Generate Calibration Files tool generates ASAP2 file
modelName.a2l. The ASAP2 file contains an IF_DATA XCP block that describes the Simulink
Coder XCP slave configuration.

…
/begin IF_DATA XCP      
  /begin PROTOCOL_LAYER
  …  
  /end PROTOCOL_LAYER
  …
  /begin XCP_ON_TCP_IP
  …
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  /end XCP_ON_TCP_IP
/end IF_DATA
…

Import the ASAP2 file into your third-party tool and manually run the external mode application on
your target hardware. Through XCP, connect the third-party tool to the target application. Then, using
that tool, perform data acquisition and calibration of the generated code.

See Also
coder.asap2.export

More About
• “Generate ASAP2 and CDF Calibration Files”
• “External Mode Simulation by Using XCP Communication” on page 58-7
• “Customize XCP Slave Software” on page 58-35
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Direct Memory Access to Generated
Code for Simulink Coder
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Access Memory in Generated Code Using Global Data Map
Simulink Coder provides a Target Language Compiler (TLC) function library that lets you create a
global data map record. The global data map record, when generated, is added to the
CompiledModel structure in the model.rtw file. The global data map record is a database
containing information required for accessing memory in the generated code, including

• Signals (Block I/O)
• Parameters
• Data type work vectors (DWork)
• External inputs
• External outputs

Use of the global data map requires knowledge of the Target Language Compiler and of the structure
of the model.rtw file. See “Target Language Compiler Overview” for information on these topics.

The TLC functions that are required to generate and access the global data map record are contained
in matlabroot/rtw/c/tlc/mw/globalmaplib.tlc. The comments in the source code fully
document the global data map structures and the library functions.

The global data map structures and functions might be modified or enhanced in future releases.

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”

62 Direct Memory Access to Generated Code for Simulink Coder

62-2



Desktops in Simulink Coder

• “Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System
Target File” on page 63-2

• “Run Rapid Simulations Over Range of Parameter Values” on page 63-24
• “Run Batch Simulations Without Recompiling Generated Code” on page 63-30
• “Use MAT-Files to Feed Data to Inport Blocks for Rapid Simulations” on page 63-35
• “Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target”

on page 63-40
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Accelerate, Refine, and Test Hybrid Dynamic System on Host
Computer by Using RSim System Target File

After you create a model, you can use the rapid simulation (RSim) system target file to characterize
model behavior. The executable program that results from the build process is for non-real-time
execution on your development computer. The executable program is highly optimized for simulating
models of hybrid dynamic systems, including models that use variable-step solvers and zero-crossing
detection. The speed of the generated code makes the RSim system target file ideal for building
programs for batch or Monte Carlo simulations.

About Rapid Simulation
Use the RSim target to generate an executable that runs fast, standalone simulations. You can repeat
simulations with varying data sets, interactively or programmatically with scripts, without rebuilding
the model. This can accelerate the characterization and tuning of model behavior and code
generation testing.

Using command-line options:

• Define parameter values and input signals in one or more MAT-files that you can load and reload
at the start of simulations without rebuilding your model.

• Redirect logging data to one or more MAT-files that you can then analyze and compare.
• Control simulation time.
• Specify external mode options.

Note To run an RSim executable, configure your computer to run MATLAB and have the MATLAB
and Simulink installation folders accessible. To deploy a standalone host executable ( i.e., without
MATLAB and Simulink installed), consider using the Host-Based Shared Library target (ert_shrlib)."

Rapid Simulation Advantage
The advantage that you gain from rapid simulation varies. Larger simulations achieve speed
improvements of up to 10 times faster than standard Simulink simulations. Some models might not
show noticeable improvement in simulation speed. To determine the speed difference for your model,
time your standard Simulink simulation and compare the results with a rapid simulation. In addition,
test the model simulation in Rapid Accelerator simulation mode.

General Rapid Simulation Workflow
Like other stages of Model-Based Design, characterization and tuning of model behavior is an
iterative process, as shown in the general workflow diagram in the figure. Tasks in the workflow are:

1 Identify your rapid simulation requirements. on page 63-3
2 Configure Inport blocks on page 63-4 that provide input source data for rapid simulations.
3 Configure the model on page 63-4 for rapid simulation.
4 Set up simulation input data. on page 63-6
5 Run the rapid simulations. on page 63-13
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Identify Rapid Simulation Requirements
The first step to setting up a rapid simulation is to identify your simulation requirements.

Question... For More Information, See...
How long do you want simulations to run? “Configure and Build Model for Rapid Simulation” on page

63-4
Are there solver requirements? Do you expect to
use the same solver for which the model is
configured for your rapid simulations?

“Configure and Build Model for Rapid Simulation” on page
63-4

Do your rapid simulations need to accommodate
flexible custom code interfacing? Or, do your
simulations need to retain storage class
settings?

“Configure and Build Model for Rapid Simulation” on page
63-4

Will you be running simulations with multiple
data sets?

“Set Up Rapid Simulation Input Data” on page 63-6

Will the input data consist of global parameters,
signals, or both?

“Set Up Rapid Simulation Input Data” on page 63-6

What type of source blocks provide input data to
the model — From File, Inport, From
Workspace?

“Set Up Rapid Simulation Input Data” on page 63-6

Will the model's parameter vector (model_P) be
used as input data?

“Create a MAT-File That Includes a Model Parameter
Structure” on page 63-6
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Question... For More Information, See...
What is the data type of the input parameters
and signals?

“Set Up Rapid Simulation Input Data” on page 63-6

Will the source data consist of one variable or
multiple variables?

“Set Up Rapid Simulation Input Data” on page 63-6

Does the input data include tunable
parameters?

“Create a MAT-File That Includes a Model Parameter
Structure” on page 63-6

Do you need to gain access to tunable
parameter information — model checksum and
parameter data types, identifiers, and
complexity?

“Create a MAT-File That Includes a Model Parameter
Structure” on page 63-6

Will you have a need to vary the simulation stop
time for simulation runs?

“Configure and Build Model for Rapid Simulation” on page
63-4 and“Override a Model Simulation Stop Time” on page
63-15

Do you want to set a time limit for the
simulation? Consider setting a time limit if your
model experiences frequent zero crossings and
has a small minor step size.

“Set a Clock Time Limit for a Rapid Simulation” on page 63-
15

Do you need to preserve the output of each
simulation run?

“Specify a New Output File Name for a Simulation” on page
63-21 and “Specify New Output File Names for To File
Blocks” on page 63-21

Do you expect to run the simulations
interactively or in batch mode?

“Scripts for Batch and Monte Carlo Simulations” on page 63-
13

Configure Inports to Provide Simulation Source Data
You can use Inport blocks as a source of input data for rapid simulations. To do so, configure the
blocks so that they can import data from external MAT-files. By default, the Inport block inherits
parameter settings from downstream blocks. In most cases, to import data from an external MAT-file,
you must explicitly set the following block parameters to match the source data in the MAT-file.

• Main > Interpolate data
• Signal Attributes > Port dimensions
• Signal Attributes > Data type
• Signal Attributes > Signal type

If you do not have control over the model content, you might need to modify the data in the MAT-file
to conform to what the model expects for input. Input data characteristics and specifications of the
Inport block that receives the data must match.

For details on adjusting these parameters and on creating a MAT-file for use with an Inport block, see
“Create a MAT-File for an Inport Block” on page 63-10. For descriptions of the preceding block
parameters, see the block description of Inport.

Configure and Build Model for Rapid Simulation
After you identify your rapid simulation requirements, configure the model for rapid simulation.
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1 Set model configuration parameter System target file to rsim.tlc (Rapid Simulation Target).
2 Click RSim Target to view the RSim Target pane.

3 Set the RSim target configuration parameters for your rapid simulation requirements.

If You Want to... Then...
Generate code that allows the RSim executable to
load parameters from a MAT-file

Select Enable RSim executable to load parameters
from a MAT-file (default).

Let the target choose a solver based on the solver
already configured for the model

Set Solver selection to auto (default). The code
generator uses a built-in solver if a fixed-step solver is
specified on the Solver pane or calls the Simulink
solver module (a shared library) if a variable-step solver
is specified.

Explicitly instruct the target to use a fixed-step
solver

Set Solver selection to Use fixed-step solvers.
In the Configuration Parameters dialog box, on the
Solver pane, specify a fixed-step solver.

Explicitly instruct the target to use a variable-
step solver

Set Solver selection to Use Simulink solver
module. In the Configuration Parameters dialog box, on
the Solver pane, specify a variable-step solver.

Force storage classes to Auto for flexible custom
code interfacing

Select Force storage classes to AUTO (default).

Retain storage class settings, such as
ExportedGlobal or ImportedExtern, due to
application requirements

Clear Force storage classes to AUTO.

4 Set up data import and export options. On the Data Import/Export pane, in the Save to
Workspace section, select the Time, States, Outputs, and Final States parameters, as they
apply. By default, the code generator saves simulation logging results to a file named
model.mat. For more information, see “Export Simulation Data”.

5 If you are using external mode communication, set up the interface, using the Code Generation
> Interface pane. See “External Mode Simulations for Parameter Tuning and Signal Monitoring”
for details.

6 Press Ctrl+B. The code generator builds a highly optimized executable program that you can run
on your development computer with varying data, without rebuilding.

For more information on compilers that are compatible with the Simulink Coder product, see
“Select and Configure C or C++ Compiler” on page 57-3 and “Template Makefiles and Make
Options” on page 57-21 .
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Set Up Rapid Simulation Input Data
• “About Rapid Simulation Data Setup” on page 63-6
• “Create a MAT-File That Includes a Model Parameter Structure” on page 63-6
• “Create a MAT-File for a From File Block” on page 63-9
• “Create a MAT-File for an Inport Block” on page 63-10

About Rapid Simulation Data Setup

The format and setup of input data for a rapid simulation depends on your requirements.

If the Input Data Source Is... Then...
The model's global parameter vector
(model_P)

Use the rsimgetrtp function to get the vector content
and then save it to a MAT-file.

The model's global parameter vector and
you want a mapping between the vector
and tunable parameters

Call the rsimgetrtp function to get the global
parameter structure and then save it to a MAT-file.

Provided by a From File block Create a MAT-file that a From File block can read.
Provided by an Inport block Create a MAT-file that adheres to one of the three data

file formats that the Inport block can read.
Provided by a From Workspace block Create structure variables in the MATLAB workspace.

The RSim target requires that MAT-files used as input for From File and Inport blocks contain data.
The grt target inserts MAT-file data directly into the generated code, which is then compiled and
linked as an executable. In contrast, RSim allows you to replace data sets for each successive
simulation. A MAT-file containing From File or Inport block data must be present if a From File block
or Inport block exists in your model.

Create a MAT-File That Includes a Model Parameter Structure

To create a MAT-file that includes a model global parameter structure (model_P),

1 Get the structure by calling the function rsimgetrtp.
2 Save the parameter structure to a MAT-file.

If you want to run simulations over varying data sets, consider converting the parameter structure to
a cell array and saving the parameter variations to a single MAT-file.

Get the Parameter Structure for a Model

Get the global parameter structure (model_P) for a model by calling the function rsimgetrtp.

param_struct = rsimgetrtp('model')

Argument Description
model The model for which you are running the rapid simulations.

The rsimgetrtp function forces an update diagram action for the specified model and returns a
structure that contains the following fields.
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Field Description
modelChecksum A four-element vector that encodes the structure of the model. The code

generator uses the checksum to check whether the structure of the model
has changed since the RSim executable was generated. If you delete or add
a block, and then generate a new model_P vector, the new checksum does
not match the original checksum anymore. The RSim executable detects this
incompatibility in parameter vectors and exits to avoid returning incorrect
simulation results. If the model structure changes, you must regenerate the
code for the model.

parameters A structure that contains the model's global parameters.

The parameter structure contains the following information.

Field Description
dataTypeName The name of the parameter data type, for example, double
dataTypeID Internal data type identifier used by the code generator
complex The value 0 if real; 1 if complex
dtTransIdx Internal data index used by the code generator
values A vector of the parameter values associated with this structure
map This field contains the mapping information that correlates the 'values' to

the tunable parameters of the model. This mapping information, in
conjunction with rsimsetrtpparam, is useful for creating subsequent rtP
structures without compiling the block diagram.

The code generator reports a tunable fixed-point parameter according to its stored value. For
example, an sfix(16) parameter value of 1.4 with a scaling of 2^-8 has a value of 358 as an
int16.

In the following example, rsimgetrtp returns the parameter structure for the example model
rtwdemo_rsimtf to param_struct.

param_struct = rsimgetrtp('rtwdemo_rsimtf')

param_struct = 

    modelChecksum: [1.7165e+009 3.0726e+009 2.6061e+009 2.3064e+009]
       parameters: [1x1 struct]

Save the Parameter Structure to a MAT-File

After you issue a call to rsimgetrtp, save the return value of the function call to a MAT-file. Using a
command-line option, you can then specify that MAT-file as input for rapid simulations.

The following example saves the parameter structure returned for rtwdemo_rsimtf to the MAT-file
myrsimdemo.mat.

save myrsimdemo.mat param_struct;

For information on using command-line options to specify required files, see “Run Rapid Simulations”
on page 63-13.
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Convert the Parameter Structure for Running Simulations on Varying Data Sets

To use rapid simulations to test changes to specific parameters, you can convert the model parameter
structure to a cell array. You can then access a specific parameter set by using the @ operator to
specify the index for a specific parameter set in the file.

To convert the structure to a cell array:

1 Use the function rsimgetrtp to get a structure containing parameter information for the
example model rtwdemo_rsimtf. Store the structure in a variable param_struct.

param_struct = rsimgetrtp('rtwdemo_rsimtf');

The parameters field of the structure is a substructure that contains parameter information.
The values field of the parameters substructure contains the numeric values of the
parameters that you can tune during execution of the simulation code.

2 Use the function rsimsetrtpparam to expand the structure so that it contains more parameter
sets. In this case, create two more parameter sets (for a total of three sets).

param_struct = rsimsetrtpparam(param_struct,3);

The function converts the parameters field to a cell array with three elements. Each element
contains information for a single parameter set. By default, the function creates the second and
third elements of the cell array by copying the first element. Therefore, all of the parameter sets
use the same parameter values.

3 Specify new values for the parameters in the second and third parameter sets.

param_struct.parameters{2}.values = [-150 -5000 0 4950];
param_struct.parameters{3}.values = [-170 -5500 0 5100];

4 Save the structure containing the parameter set information to a MAT-file.

save rtwdemo_rsimtf.mat param_struct;

Alternatively, you can modify the block parameters in the model, and use rsimgetrtp to create
multiple parameter sets:

1 Use the function rsimgetrtp to get a structure containing parameter information for the
example model rtwdemo_rsimtf. Store the structure in a variable param_struct.

param_struct = rsimgetrtp('rtwdemo_rsimtf');
2 Use the function rsimsetrtpparam to expand the structure so that it contains more parameter

sets. In this case, create two more parameter sets (for a total of three sets).

param_struct = rsimsetrtpparam(param_struct,3);

The function converts the parameters field to a cell array with three elements. Each element
contains information for a single parameter set. By default, the function creates the second and
third elements of the cell array by copying the first element. Therefore, all of the parameter sets
use the same parameter values.

3 Change the values of block parameters or workspace variables. For example, change the value of
the variable w from 70 to 72.

w = 72;
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4 Use rimsgetrtp to get another structure containing parameter information. Store the structure
in a temporary variable rtp_temp.

rtp_temp = rsimgetrtp('rtwdemo_rsimtf');
5 Assign the value of the parameters field of rtp_temp to the structure param_struct as a

second parameter set.

param_struct.parameters{2} = rtp_temp.parameters;
6 Change the value of the variable w from 72 to 75.

w = 75;
7 Use rimsgetrtp to get another structure containing parameter information. Then, assign the

value of the parameters field to param_struct as a third parameter set.

rtp_temp = rsimgetrtp('rtwdemo_rsimtf');
param_struct.parameters{3} = rtp_temp.parameters;

8 Save the structure containing the parameter set information to a MAT-file.

save rtwdemo_rsimtf.mat param_struct;

For more information on how to specify each parameter set when you run the simulations, see
“Change Block Parameters for an RSim Simulation” on page 63-20.

Create a MAT-File for a From File Block

You can use a MAT-file as the input data source for a From File block. The format of the data in the
MAT-file must match the data format expected by that block. For example, if you are using a matrix as
an input for the MAT file, this cannot be different from the matrix size for the executable.

To create a MAT-file for a From File block:

1 For array format data, in the workspace create a matrix that consists of two or more rows. The
first row must contain monotonically increasing time points. Other rows contain data points that
correspond to the time point in that column. The time and data points must be data of type
double.

For example:

t=[0:0.1:2*pi]';
Ina1=[2*sin(t) 2*cos(t)];
Ina2=sin(2*t);
Ina3=[0.5*sin(3*t) 0.5*cos(3*t)];
var_matrix=[t Ina1 Ina2 Ina3]';

For other supported data types, such as int16 or fixed-point, the time data points must be of
type double, just as for array format data. However, the sample data can be of any dimension.

For more information on setting up the input data, see the block description of From File.
2 Save the matrix to a MAT-file.

The following example saves the matrix var_matrix to the MAT-file myrsimdemo.mat in
Version 7.3 format.

save '-v7.3' myrsimdemo.mat var_matrix;
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Using a command-line option, you can then specify that MAT-file as input for rapid simulations.

Create a MAT-File for an Inport Block

You can use a MAT-file as the input data source for an Inport block.

The format of the data in the MAT-file must adhere to one of the three column-based formats listed in
the following table. The table lists the formats in order from least flexible to most flexible.

Format Description
Single time/data matrix • Least flexible.

• One variable.
• Two or more columns. Number of columns must equal the sum of the dimensions

of all root Inport blocks plus 1. First column must contain monotonically
increasing time points. Other columns contain data points that correspond to the
time point in a given row.

• Data of type double.

For an example, see Single time/data matrix in the following procedure, step 4. For
more information, see “Loading Data Arrays to Root-Level Inputs”.

Signal-and-time
structure

• More flexible than the single time/data matrix format.
• One variable.
• Must contain two top-level fields: time and signals. The time field contains a

column vector of the simulation times. The signals field contains an array of
substructures, each of which corresponds to an Inport block. The substructure
index corresponds to the Inport block number. Each signals substructure must
contain a field named values. The values field must contain an array of inputs
for the corresponding Inport block, where each input corresponds to a time point
specified by the time field.

• If the time field is set to an empty value, clear the check box for the Inport block
Interpolate data parameter.

• Data type must match Inport block settings.

For an example, see Signal-and-time structure in the following procedure, step 4.
For more information on this format, see “Loading Data Structures to Root-Level
Inputs”.
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Format Description
Per-port structure • Most flexible

• Multiple variables. Number of variables must equal the number of Inport blocks.
• Consists of a separate structure-with-time or structure-without-time for each

Inport block. Each Inport block data structure has only one signals field. To use
this format, in the Input text field, enter the names of the structures as a comma-
separated list, in1, in2,..., inN, where in1 is the data for your model's first port,
in2 for the second port, and so on.

• Each variable can have a different time vector.
• If the time field is set to an empty value, clear the check box for the Inport block

Interpolate data parameter.
• Data type must match Inport block settings.
• To save multiple variables to the same data file, you must save them in the order

expected by the model, using the -append option.

For an example, see Per-port structure in the following procedure, step 4. For more
information, see “Loading Data Structures to Root-Level Inputs”.

The supported formats and the following procedure are illustrated in rtwdemo_rsim_i.

To create a MAT-file for an Inport block:

1 Choose one of the preceding data file formats.
2 Update Inport block parameter settings and specifications to match specifications of the data to

be supplied by the MAT-file.

By default, the Inport block inherits parameter settings from downstream blocks. To import data
from an external MAT-file, explicitly set the following parameters to match the source data in the
MAT-file.

• Main > Interpolate data
• Signal Attributes > Port dimensions
• Signal Attributes > Data type
• Signal Attributes > Signal type

If you choose to use a structure format for workspace variables and the time field is empty,clear
block parameter Interpolate data or modify the parameter so that it is set to a nonempty value.
Interpolation requires time data.

For descriptions of the preceding block parameters, see the block description of Inport.
3 Build an RSim executable program for the model. The build process creates and calculates a

structural checksum for the model and embeds it in the generated executable. The RSim target
uses the checksum to verify that data being passed into the model is consistent with what the
model executable expects.

4 Create the MAT-file that provides the source data for the rapid simulations. You can create the
MAT-file from a workspace variable. Using the specifications in the preceding format comparison
table, create the workspace variables for your simulations.

An example of each format follows:
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Single time/data matrix

t=[0:0.1:2*pi]';
Ina1=[2*sin(t) 2*cos(t)];
Ina2=sin(2*t);
Ina3=[0.5*sin(3*t) 0.5*cos(3*t)];
var_matrix=[t Ina1 Ina2 Ina3];

Signal-and-time structure

t=[0:0.1:2*pi]';
var_single_struct.time=t;
var_single_struct.signals(1).values(:,1)=2*sin(t);
var_single_struct.signals(1).values(:,2)=2*cos(t);
var_single_struct.signals(2).values=sin(2*t);
var_single_struct.signals(3).values(:,1)=0.5*sin(3*t);
var_single_struct.signals(3).values(:,2)=0.5*cos(3*t);
v=[var_single_struct.signals(1).values...
var_single_struct.signals(2).values...
var_single_struct.signals(3).values];

Per-port structure

t=[0:0.1:2*pi]';
Inb1.time=t;
Inb1.signals.values(:,1)=2*sin(t);
Inb1.signals.values(:,2)=2*cos(t);
t=[0:0.2:2*pi]';
Inb2.time=t;
Inb2.signals.values(:,1)=sin(2*t);
t=[0:0.1:2*pi]';
Inb3.time=t;
Inb3.signals.values(:,1)=0.5*sin(3*t);
Inb3.signals.values(:,2)=0.5*cos(3*t);

5 Save the workspace variables to a MAT-file.

Single time/data matrix

The following example saves the workspace variable var_matrix to the MAT-file
rsim_i_matrix.mat.

save rsim_i_matrix.mat var_matrix;

Signal-and-time structure

The following example saves the workspace structure variable var_single_struct to the MAT-
file rsim_i_single_struct.mat.

save rsim_i_single_struct.mat var_single_struct;

Per-port structure

To order data when saving per-port structure variables to a single MAT-file, use the save
command's -append option. Be sure to append the data in the order that the model expects it.

The following example saves the workspace variables Inb1, Inb2, and Inb3 to MAT-file
rsim_i_multi_struct.mat.
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save rsim_i_multi_struct.mat Inb1;
save rsim_i_multi_struct.mat Inb2 -append;
save rsim_i_multi_struct.mat Inb3 -append;

The save command does not preserve the order in which you specify your workspace variables
in the command line when saving data to a MAT-file. For example, if you specify the variables v1,
v2, and v3, in that order, the order of the variables in the MAT-file could be v2 v1 v3.

Using a command-line option, you can then specify the MAT-files as input for rapid simulations.

Scripts for Batch and Monte Carlo Simulations
The RSim target is for batch simulations in which parameters and input signals vary for multiple
simulations. New output file names allow you to run new simulations without overwriting prior
simulation results. You can set up a series of simulations to run by creating a .bat file for use on a
Microsoft Windows platform.

Create a file for the Windows platform with a text editor and execute it by typing the file name, for
example, mybatch, where the name of the text file is mybatch.bat.
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run1.mat -o results1.mat -tf 10.0
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run2.mat -o results2.mat -tf 10.0
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run3.mat -o results3.mat -tf 10.0
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run4.mat -o results4.mat -tf 10.0

In this case, batch simulations run using four sets of input data in files run1.mat, run2.mat, and so
on. The RSim executable saves the data to the files specified with the -o option.

The variable names containing simulation results in each of the files are identical. Therefore, loading
consecutive sets of data without renaming the data once it is in the MATLAB workspace results in
overwriting the prior workspace variable with new data. To avoid overwriting, you can copy the result
to a new MATLAB variable before loading the next set of data.

You can also write MATLAB scripts to create new signals and new parameter structures, as well as to
save data and perform batch runs using the bang command (!).

For details on running simulations and available command-line options, see “Run Rapid Simulations”
on page 63-13. For an example of a rapid simulation batch script, see the example “Run Batch
Simulations Without Recompiling Generated Code”.

Run Rapid Simulations
• “Rapid Simulations” on page 63-14
• “Requirements for Running Rapid Simulations” on page 63-15
• “Set a Clock Time Limit for a Rapid Simulation” on page 63-15
• “Override a Model Simulation Stop Time” on page 63-15
• “Read the Parameter Vector into a Rapid Simulation” on page 63-16
• “Specify New Signal Data File for a From File Block” on page 63-16
• “Specify Signal Data File for an Inport Block” on page 63-18
• “Change Block Parameters for an RSim Simulation” on page 63-20
• “Specify a New Output File Name for a Simulation” on page 63-21
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• “Specify New Output File Names for To File Blocks” on page 63-21

Rapid Simulations

Using the RSim target, you can build a model once and run multiple simulations to study effects of
varying parameter settings and input signals. You can run a simulation directly from your operating
system command line, redirect the command from the MATLAB command line by using the bang (!)
character, or execute commands from a script.

From the operating system command line, use

rtwdemo_rsimtf

From the MATLAB command line, use

!rtwdemo_rsimtf

The following table lists ways you can use RSim target command-line options to control a simulation.

To... Use...
Read input data for a From File block from a MAT-file
other than the MAT-file used for the previous
simulation

model -f oldfilename.mat=newfilename.mat

Print a summary of the options for RSim executable
targets

executable filename -h

Read input data for an Inport block from a MAT-file model -i filename.mat
Time out after n clock time seconds, where n is a
positive integer value

model -L n

Write MAT-file logging data to file filename.mat model -o filename.mat
Read a parameter vector from file filename.mat model -p filename.mat
Override the default TCP port (17725) for external
mode

model -port TCPport

Write MAT-file logging data to a MAT-file other than the
MAT-file used for the previous simulation

model -t oldfilename.mat=newfilename.mat

Run the simulation until the time value stoptime is
reached

model -tf stoptime

Run in verbose mode model -v
Wait for the Simulink engine to start the model in
external mode

model -w

The following sections use the rtwdemo_rsimtf example model in examples to illustrate some of
these command-line options. In each case, the example assumes you have already done the following:

• Created or changed to a working folder.
• Opened the example model.
• Copied the data file matlabroot/toolbox/rtw/rtwdemos/rsimdemos/rsim_tfdata.mat to

your working folder. You can perform this operation using the command:

copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos',...
'rsimdemos','rsim_tfdata.mat'),pwd);
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Requirements for Running Rapid Simulations

The following requirements apply to both fixed and variable step executables.

• You must run the RSim executable on a computer configured to run MATLAB. Also, the RSim.exe
file must be able to access the MATLAB and Simulink installation folders on this machine. To
obtain that access, your PATH environment variable must include /bin and /bin/($ARCH), where
($ARCH) represents your operating system architecture. For example, for a personal computer
running on a Windows platform, ($ARCH) is “win64”, whereas for a Linux machine, ($ARCH) is
“glnxa64”.

• On GNU Linux platforms, to run an RSim executable, define the LD_LIBRARY_PATH environment
variable to provide the path to the MATLAB installation folder, as follows:
% setenv LD_LIBRARY_PATH /matlab/sys/os/glnx64:$LD_LIBRARY_PATH

• On the Apple Macintosh OS X platform, to run RSim target executables, you must define the
environment variable DYLD_LIBRARY_PATH to include the folders bin/mac and sys/os/mac
under the MATLAB installation folder. For example, if your MATLAB installation is under /
MATLAB, add /MATLAB/bin/mac and /MATLAB/sys/os/mac to the definition for
DYLD_LIBRARY_PATH.

Set a Clock Time Limit for a Rapid Simulation

If a model experiences frequent zero crossings and the model's minor step size is small, consider
setting a time limit for a rapid simulation. To set a time limit, specify the -L option with a positive
integer value. The simulation aborts after running for the specified amount of clock time (not
simulation time). For example,

  !rtwdemo_rsimtf -L 20

Based on your clock, after the executable runs for 20 seconds, the program terminates. You see a
message similar to one of the following:

• On a Microsoft Windows platform,

Exiting program, time limit exceeded
Logging available data ...

• On The Open Group UNIX platform,

** Received SIGALRM (Alarm) signal @ Fri Jul 25 15:43:23 2003
** Exiting model  'vdp' @ Fri Jul 25 15:43:23 2003

You do not need to do anything to your model or to its configuration to use this option.

Override a Model Simulation Stop Time

By default, a rapid simulation runs until the simulation time reaches the time specified the
Configuration Parameters dialog box, on the Solver pane. You can override the model simulation stop
time by using the -tf option. For example, the following simulation runs until the time reaches 6.0
seconds.

!rtwdemo_rsimtf -tf 6.0

The RSim target stops and logs output data using MAT-file data logging rules.

If the model includes a From File block, the end of the simulation is regulated by the stop time setting
specified in the Configuration Parameters dialog box, on the Solver pane, or with the RSim target
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option -tf. The values in the block's time vector are ignored. However, if the simulation time exceeds
the endpoints of the time and signal matrix (if the final time is greater than the final time value of the
data matrix), the signal data is extrapolated to the final time value.

Read the Parameter Vector into a Rapid Simulation

To read the model parameter vector into a rapid simulation, you must first create a MAT-file that
includes the parameter structure as described in “Create a MAT-File That Includes a Model
Parameter Structure” on page 63-6. You can then specify the MAT-file in the command line with the -
p option.

For example:

1 Build an RSim executable for the example model rtwdemo_rsimtf.
2 Modify parameters in your model and save the parameter structure.

param_struct = rsimgetrtp('rtwdemo_rsimtf');
save myrsimdata.mat param_struct

3 Run the executable with the new parameter set.

!rtwdemo_rsimtf -p myrsimdata.mat

** Starting model 'rtwdemo_rsimtf' @ Tue Dec 27 12:30:16 2005 
** created rtwdemo_rsimtf.mat **

4 Load workspace variables and plot the simulation results by entering the following commands:

load myrsimdata.mat
plot(rt_yout)

Specify New Signal Data File for a From File Block

If your model's input data source is a From File block, you can feed the block with input data during
simulation from a single MAT-file or you can change the MAT-file from one simulation to the next.
Each MAT-file must adhere to the format described in “Create a MAT-File for a From File Block” on
page 63-9.

To change the MAT-file after an initial simulation, you specify the executable with the -f option and
an oldfile.mat=newfile.mat parameter, as shown in the following example.

1 Set some parameters in the MATLAB workspace. For example:

w = 100;
theta = 0.5;

2 Build an RSim executable for the example model rtwdemo_rsimtf.
3 Run the executable.

!rtwdemo_rsimtf

The RSim executable runs a set of simulations and creates output MAT-files containing the
specific simulation result.

4 Load the workspace variables and plot the simulation results by entering the following
commands:

load rtwdemo_rsimtf.mat
plot(rt_yout)
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The resulting plot shows simulation results based on default input data.

5 Create a new data file, newfrom.mat, that includes the following data:

t=[0:.001:1];
u=sin(100*t.*t);
tu=[t;u];
save newfrom.mat tu;

6 Run a rapid simulation with the new data by using the -f option to replace the original file,
rsim_tfdata.mat, with newfrom.mat.

!rtwdemo_rsimtf -f rsim_tfdata.mat=newfrom.mat
7 Load the data and plot the new results by entering the following commands:

load rtwdemo_rsimtf.mat
plot(rt_yout)

The next figure shows the resulting plot.
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From File blocks require input data of type double. If you need to import signal data of a data type
other than double, use an Inport block (see “Create a MAT-File for an Inport Block” on page 63-10)
or a From Workspace block with the data specified as a structure.

Workspace data must be in the format:

variable.time
variable.signals.values

If you have more than one signal, use the following format:

variable.time
variable.signals(1).values
variable.signals(2).values

Specify Signal Data File for an Inport Block

If your model's input data source is an Inport block, you can feed the block with input data during
simulation from a single MAT-file or you can change the MAT-file from one simulation to the next.
Each MAT-file must adhere to one of the three formats described in “Create a MAT-File for an Inport
Block” on page 63-10.

To specify the MAT-file after a simulation, you specify the executable with the -i option and the name
of the MAT-file that contains the input data. For example:

1 Open the model rtwdemo_rsim_i.
2 Check the Inport block parameter settings. The following Inport block data parameter settings

and specifications that you specify for the workspace variables must match settings in the MAT-
file, as indicated in “Configure Inports to Provide Simulation Source Data” on page 63-4:

• Main > Interpolate data
• Signal Attributes > Port dimensions
• Signal Attributes > Data type
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• Signal Attributes > Signal type
3 Build the model.
4 Set up the input signals. For example:

t=[0:0.01:2*pi]';
s1=[2*sin(t) 2*cos(t)];
s2=sin(2*t);
s3=[0.5*sin(3*t) 0.5*cos(3*t)];
plot(t, [s1 s2 s3])

5 Prepare the MAT-file by using one of the three available file formats described in “Create a MAT-
File for an Inport Block” on page 63-10. The following example defines a signal-and-time
structure in the workspace and names it var_single_struct.

t=[0:0.1:2*pi]';
var_single_struct.time=t;
var_single_struct.signals(1).values(:,1)=2*sin(t);
var_single_struct.signals(1).values(:,2)=2*cos(t);
var_single_struct.signals(2).values=sin(2*t);
var_single_struct.signals(3).values(:,1)=0.5*sin(3*t);
var_single_struct.signals(3).values(:,2)=0.5*cos(3*t);
v=[var_single_struct.signals(1).values...
var_single_struct.signals(2).values...
var_single_struct.signals(3).values];

6 Save the workspace variable var_single_struct to MAT-file rsim_i_single_struct.

save rsim_i_single_struct.mat var_single_struct;
7 Run a rapid simulation with the input data by using the -i option. Load and plot the results.

!rtwdemo_rsim_i -i rsim_i_single_struct.mat

** Starting model 'rtwdemo_rsim_i' @ Tue Aug 19 10:26:53 2014 
 *** rsim_i_single_struct.mat is successfully loaded! *** 
** created rtwdemo_rsim_i.mat ** 
 
** Execution time = 0.02024185130718954s
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8 Load and plot the results.

load rtwdemo_rsim_i.mat
plot(rt_tout, rt_yout);

Change Block Parameters for an RSim Simulation

As described in “Create a MAT-File That Includes a Model Parameter Structure” on page 63-6, after
you alter one or more parameters in a Simulink block diagram, you can extract the parameter vector,
model_P, for the entire model. You can then save the parameter vector, along with a model
checksum, to a MAT-file. This MAT-file can be read directly by the standalone RSim executable,
allowing you to replace the entire parameter vector or individual parameter values, for running
studies of variations of parameter values representing coefficients, new data for input signals, and so
on.

RSim can read the MAT-file and replace the entire model_P structure whenever you change one or
more parameters, without recompiling the entire model.

For example, assume that you changed one or more parameters in your model, generated the new
model_P vector, and saved model_P to a new MAT-file called mymatfile.mat. To run the same
rtwdemo_rsimtf model and use these new parameter values, use the -p option, as shown in the
following example:

!rtwdemo_rsimtf -p mymatfile.mat
load rtwdemo_rsimtf 
plot(rt_yout)

If you have converted the parameter structure to a cell array for running simulations on varying data
sets, as described in “Convert the Parameter Structure for Running Simulations on Varying Data
Sets” on page 63-8, you must add an @n suffix to the MAT-file specification. n is the element of the cell
array that contains the specific input that you want to use for the simulation.
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The following example converts param_struct to a cell array, changes parameter values, saves the
changes to MAT-file mymatfile.mat, and then runs the executable using the parameter values in the
second element of the cell array as input.

param_struct = rsimgetrtp('rtwdemo_rsimtf');
param_struct = rsimsetrtpparam(param_struct,2);
param_struct.parameters{1}

ans = 

       dataTypeName: 'double'
         dataTypeId: 0
            complex: 0
         dtTransIdx: 0
             values: [-140 -4900 0 4900]
                map: []
    structParamInfo: []

param_struct.parameters{2}.values=[-150 -5000 0 4950];
save mymatfile.mat param_struct;
!rtwdemo_rsimtf -p mymatfile.mat@2 -o rsim2.mat

Specify a New Output File Name for a Simulation

If you have specified one or more of the Save to Workspace parameters — Time, States, Outputs,
or Final States — in the Configuration Parameters dialog box, on the Data Import/Export pane, the
default is to save simulation logging results to the file model.mat. For example, the example model
rtwdemo_rsimtf normally saves data to rtwdemo_rsimtf.mat, as follows:

!rtwdemo_rsimtf
created rtwdemo_rsimtf.mat

You can specify a new output file name for data logging by using the -o option when you run an
executable.

!rtwdemo_rsimtf -o rsim1.mat

In this case, the set of parameters provided at the time of code generation, including From File block
data parameters, is run.

Specify New Output File Names for To File Blocks

In much the same way as you can specify a new system output file name, you can also provide new
output file names for data saved from one or more To File blocks. To do this, specify the original file
name at the time of code generation with a new name, as shown in the following example:

!rtwdemo_rsimtf -t rtwdemo_rsimtf_data.mat=mynewrsimdata.mat

In this case, assume that the original model wrote data to the output file
rtwdemo_rsimtf_data.mat. Specifying a new file name forces RSim to write to the file
mynewrsimdata.mat. With this technique, you can avoid overwriting an existing simulation run.

Tune Parameters Interactively During Rapid Simulation
The RSim system target file was designed to let you run batch simulations at the fastest possible
speed. Using variable-step or fixed-step solvers with that system target file and a tunable parameter
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data structure, whether you set Default parameter behavior to Tunable or to Inlined, you can
create multiple parameter sets. You can run the data sets with the generated executable program
(.exe on Windows). Each invocation of the executable program allows specification of the file name to
use for results.

For this example, Default parameter behavior is set to Inlined. The model declares workspace
variables as tunable parameters. To use the RSim system target file with Default parameter
behavior set to Tunable, and without explicitly declaring tunable parameters, see “Run Batch
Simulations Without Recompiling Generated Code”.

Open Example Model

Open the example model rtwdemo_rsim_param_tuning.

open_system('rtwdemo_rsim_param_tuning');

This model uses the RSim target and the rsimgetrtp function to allow a non real time executable to
be passed new data without the need to recompile the Simulink model. This feature allows you to get
a map of the tunable parameters declared in a model and save it in a MAT-file. You can then create
your own MATLAB GUI or a standalone GUI (independent of MATLAB) to read and write the MAT-file
and rerun the executable to produce new output files.

In the model, double-click the buttons sequentially to run the example.

To review the code used to create the MATLAB graphical interface and the standalone graphical
interface, double-click the View MATLAB programs button.

For more information, see “Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by
Using RSim System Target File”.

Rapid Simulation Target Limitations
The RSim target has the following limitations:
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• Does not support algebraic loops.
• Does not support Interpreted MATLAB Function blocks.
• Does not support noninlined MATLAB language or Fortran S-functions.
• If an RSim build includes referenced models (by using Model blocks), set up these models to use
fixed-step solvers to generate code for them. The top model, however, can use a variable-step
solver as long as the blocks in the referenced models are discrete.

• In certain cases, changing block parameters can result in structural changes to your model that
change the model checksum. An example of such a change is changing the number of delays in a
DSP simulation. In such cases, you must regenerate the code for the model.

See Also

More About
• “Acceleration”
• “Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function

Target”
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Run Rapid Simulations Over Range of Parameter Values
This example shows how to use the RSim system target file to run simulations over a range of
parameter values. The example uses the Van der Pol oscillator and performs a parameter sweep over
a range of initial state values to obtain the phase diagram of a nonlinear system.

You can customize this example for your own application by modifying the MATLAB® script used to
build this example. Click the link in the top left corner of this page to edit the MATLAB® script. Click
the link in the top right corner to run this example from MATLAB®. Run the example from writable
location. The example creates files that you may want to investigate later.

For this example, set model configuration parameter Default parameter behavior to Inlined. In
the example, you create Simulink.Parameter objects as tunable parameters. To use RSim with
Default parameter behavior set to Tunable, and without explicitly declaring tunable parameters,
see “Run Batch Simulations Without Recompiling Generated Code”.

To run multiple simulations in the Simulink environment, consider using rapid accelerator instead of
RSim. For information about rapid accelerator, see “What Is Acceleration?”. To sweep parameter
values, see “Optimize, Estimate, and Sweep Block Parameter Values”.

Preparation Model

Make sure the current folder is writable. The example creates files.

[stat, fa] = fileattrib(pwd);
if ~fa.UserWrite
    disp('This script must be run in a writable directory');
    return
end

Open the model. Then, open the Simulink Coder app. Set model configuration parameter System
target file to rsim.tlc.

For more information on doing this graphically and setting up other RSim target related options, look
here.

mdlName = 'rtwdemo_rsim_vdp';
open_system(mdlName);
cs = getActiveConfigSet(mdlName);
cs.switchTarget('rsim.tlc',[]);
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Specify variables INIT_X1 (the initial condition for state x1), INIT_X2 (the initial condition for state
x2), and MU (the gain value) as tunable. To create tunable parameters, convert the variables to
Simulink.Parameter objects, and configure the objects to use a storage class other than Auto. In
this example you investigate how the state trajectories evolve from different initial values for states
x1 and x2 in the model.

INIT_X1 = Simulink.Parameter(INIT_X1);
INIT_X1.StorageClass = 'Model default';

INIT_X2 = Simulink.Parameter(INIT_X2);
INIT_X2.StorageClass = 'Model default';

MU = Simulink.Parameter(MU);
MU.StorageClass = 'Model default';

Define the names of files that will be created.

prmFileName = [mdlName, '_prm_sets.mat'];
logFileName = [mdlName, '_run_scr.log'];
batFileName = [mdlName, '_run_scr'];
exeFileName = mdlName;
if ispc
    exeFileName = [exeFileName, '.exe'];
    batFileName = [batFileName, '.bat'];
end
aggDataFile = [mdlName, '_results'];
startTime = cputime;

Build Model

Build the RSim executable program for the model. During the build process, a structural checksum is
calculated for the model and embedded into the generated executable program. This checksum is
used to check that a parameter set passed to the executable program is compatible with the program.

slbuild(mdlName);

### Starting build procedure for: rtwdemo_rsim_vdp
### Successful completion of build procedure for: rtwdemo_rsim_vdp

Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
rtwdemo_rsim_vdp  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.833s

Get Default Parameter Set for Model

Get the default rtP structure (parameter set) for the model. The modelChecksum field in the rtP
structure is the structural checksum of the model. This must match the checksum embedded in the
RSim executable program. If the two checksums do not match, the executable program produces an
error. rsimgetrtp generates an rtP structure with entries for the named tunable variables
INIT_X1, INIT_X2, and MU.
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rtp = rsimgetrtp(mdlName)

rtp = 

  struct with fields:

                      modelChecksum: [1x4 double]
                         parameters: [1x1 struct]
                globalParameterInfo: [1x1 struct]
    collapsedBaseWorkspaceVariables: []
                nonTunableVariables: [1x0 struct]

Create Parameter Sets

Using the rtp structure, build a structure array with different values for the tunable variables in the
model. As mentioned earlier, in this example you want see how the state trajectories evolve for
different initial values for states x1 and x2 in the model. To do this, generate different parameter sets
with different values for INIT_X1 and INIT_X2 and leave tunable variable MU set to the default
value.

INIT_X1_vals = -5:1:5;
INIT_X2_vals = -5:1:5;
MU_vals = 1;
nPrmSets = length(INIT_X1_vals)*length(INIT_X2_vals)*length(MU_vals)

nPrmSets =

   121

This example has nPrmSets parameter sets. You need to run that many simulations. Initialize
aggData, which is a structure array that holds the parameter set and corresponding results.

aggData = struct('tout', [], 'yout', [], ...
                'prms', struct('INIT_X1',[],'INIT_X2',[], 'MU', []))
aggData = repmat(aggData, nPrmSets, 1);

aggData = 

  struct with fields:

    tout: []
    yout: []
    prms: [1x1 struct]

The utility function rsimsetrtpparam builds the rtP structure by adding parameter sets one at a
time with different parameters values.

idx = 1;
for iX1 = INIT_X1_vals
    for iX2 = INIT_X2_vals
        for iMU = MU_vals
            rtp = rsimsetrtpparam(rtp,idx,'INIT_X1',iX1,'INIT_X2',iX2,'MU',iMU);
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            aggData(idx).prms.INIT_X1 = iX1;
            aggData(idx).prms.INIT_X2 = iX2;
            aggData(idx).prms.MU      = iMU;
            idx = idx + 1;
        end
    end
end

Save the rtP structure array with the parameter sets to a MAT-file.

save(prmFileName,'rtp');

Create Batch File

Create a batch script file to run the RSim executable program over the parameter sets. Each run
reads the specified parameter set from the parameter MAT-file and writes the results to the specified
output MAT-file. Use the time out option so that if a run hangs (for example, because the model has a
singularity for that parameter set), abort the run after the specified time limit and proceed to the next
run.

For example, this command (on Windows®) specifies using the third parameter set from the rtP
structure in prm.mat, writes the results to run3.mat, and aborts execution if a run takes longer
than 3600 seconds of CPU time. While running, the script pipes messages from model.exe to
run.log, which you can use to debug issues.

  model.exe -p prm.mat@3 -o run3.mat -L 3600 2>&1>> run.log

fid = fopen(batFileName, 'w');
idx = 1;
for iX1 = INIT_X1_vals
    for iX2 = INIT_X2_vals
        for iMU = MU_vals
            outMatFile = [mdlName, '_run',num2str(idx),'.mat'];
            cmd = [exeFileName, ...
                   ' -p ', prmFileName, '@', int2str(idx), ...
                   ' -o ', outMatFile, ...
                   ' -L 3600'];
            if ispc
                cmd  = [cmd, ' 2>&1>> ', logFileName];
            else % (unix)
                cmd  = ['.' filesep cmd, ' 1> ', logFileName, ' 2>&1'];
            end
            fprintf(fid, ['echo "', cmd, '"\n']);
            fprintf(fid, [cmd, '\n']);
            idx = idx + 1;
        end
    end
end
if isunix,
    system(['touch ', logFileName]);
    system(['chmod +x ', batFileName]);
end
fclose(fid);

Creating a batch/script file to run simulations enables you to call the system command once to run
the simulations (or even run the batch script outside MATLAB®) instead of calling the system
command in a loop for each simulation. This improves performance because the system command has
significant overhead.
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Execute Batch File to Run Simulations

Run the batch/script file, which runs the RSim executable program once for each parameter set and
saves the results to a different MAT-file each time. You can run the batch file from outside MATLAB®.

[stat, res] = system(['.' filesep batFileName]);
if stat ~= 0
    error(['Error running batch file ''', batFileName, ''' :', res]);
end

This example logs simulation run results in one batch file as it runs the batch file to sequentially run n
simulations over n parameter sets. You can modify the script to generate multiple batch files and run
them in parallel by distributing them across multiple computers. Also, you can run the batch files
without launching MATLAB®.

Load Output MAT-Files and Collate Results

Collect the simulation results from the output MAT-files into the structure aggData. If the output
MAT-file corresponding to a particular run is not found, set the results corresponding to that run to
NaN (not a number). This situation occurs if a simulation run with a particular set of parameters
encounters singularities in the model.

idx = 1;
for iX1 = INIT_X1_vals
    for iX2 = INIT_X2_vals
        for iMU = MU_vals
            outMatFile = [mdlName, '_run',num2str(idx),'.mat'];
            if exist(outMatFile,'file')
                load(outMatFile);
                aggData(idx).tout = rt_tout;
                aggData(idx).yout = rt_yout;
            else
                aggData(idx).tout = nan;
                aggData(idx).yout = nan;
            end
            idx = idx + 1;
        end
    end
end

Save the aggData structure to the results MAT-file. At this point, you can delete the other MAT-files,
as the aggData data structure contains the aggregation of input (parameters sets) and output data
(simulation results).

save(aggDataFile,'aggData');
disp(['Took ', num2str(cputime-startTime), ...
      ' seconds to generate results from ', ...
      num2str(nPrmSets), ' simulation runs (Steps 2 to 7).']);

Took 13.1563 seconds to generate results from 121 simulation runs (Steps 2 to 7).

Analyze Simulation Results

Plot the phase diagram (X2 versus X1) with different initial values for X1 and X2. The diagram shows
that, irrespective of the initial condition, the Van der Pol oscillator converges to its natural oscillator
mode.
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colors = {'b','g','r','c','m','y','k'}; nColors = length(colors);
for idx = 1:nPrmSets
    col = colors{idx - nColors*floor(idx/nColors) + 1};
    plot(aggData(idx).prms.INIT_X1, aggData(idx).prms.INIT_X2, [col,'x'], ...
         aggData(idx).yout(:,1), aggData(idx).yout(:,2),col);
    hold on
end
grid on
xlabel('X1');
ylabel('X2');
axis('square');
title('Phase diagram for Van der Pol equation');
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Run Batch Simulations Without Recompiling Generated Code
This example shows how to run batch simulations without recompiling the generated code. The
example modifies input signal data and model parameters by reading data from a MAT-file. In the first
part (steps 1-5), ten parameter sets are created from the Simulink® model by changing the transfer
function damping factor. The ten parameter sets are saved to a MAT-file, and the RSim executable
reads the specified parameter set from the file. In the second part (step 6-7) of this example, five sets
of signal data chirps are created with increasingly high frequencies. In both parts, the RSim
executable runs the set of simulations and creates output MAT-files containing the specific simulation
result. Finally, a composite of runs appears in a MATLAB® figure.

To quickly run multiple simulations in the Simulink environment, consider using rapid accelerator
instead of RSim. See “What Is Acceleration?”.

Step 1. Preparation

Make sure the current directory is writable because this example will be creating files.

[stat, fa] = fileattrib(pwd);
if ~fa.UserWrite
    disp('This script must be run in a writable directory');
    return;
end

Open the model and configure it to use the RSim target. For more information on doing this
graphically and setting up other RSim target related options, look here.

mdlName = 'rtwdemo_rsimtf';
open_system(mdlName);
cs = getActiveConfigSet(mdlName);
cs.switchTarget('rsim.tlc',[]);

The MAT-file rsim_tfdata.mat is required in the local directory.

if ~isempty(dir('rsim_tfdata.mat')),
    delete('rsim_tfdata.mat');
end
str1 = fullfile(matlabroot,'toolbox','rtw','rtwdemos','rsimdemos','rsim_tfdata.mat');
str2 = ['copyfile(''', str1, ''',''rsim_tfdata.mat'',''writable'')'];
eval(str2);
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Step 2. Build the Model

Build the RSim executable for the model. During the build process, a structural checksum is
calculated for the model and embedded into the generated executable. This checksum is used to
check that a parameter set passed to the executable is compatible with it.

evalin('base','w = 70;')
evalin('base','theta = 1.0;')
disp('Building compiled RSim simulation.')
slbuild(mdlName);

Building compiled RSim simulation.
### Starting build procedure for: rtwdemo_rsimtf
### Successful completion of build procedure for: rtwdemo_rsimtf

Build Summary

Top model targets built:

Model           Action                       Rebuild Reason                                    
===============================================================================================
rtwdemo_rsimtf  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.351s

Step 3. Get the Default Parameter Set and Create 10 Parameters Sets

disp('Creating rtP data files')
for i=1:10
  % Extract current rtP structure using new damping factor.
  [rtpstruct]=evalin('base','rsimgetrtp(''rtwdemo_rsimtf'');');
  savestr = strcat('save params',num2str(i),'.mat rtpstruct');
  eval(savestr);
  evalin('base','theta = theta - .1;');
end
disp('Finished creating parameter data files.')

Creating rtP data files
Finished creating parameter data files.

Step 4. Run 10 RSim Simulations Using New Parameter Sets and Plot the Results

figure
for i=1:10
  % Bang out and run a simulation using new parameter data
  runstr = ['.', filesep, 'rtwdemo_rsimtf -p params',num2str(i),'.mat', ' -v'];
  [status, result] = system(runstr);
  if status ~= 0, error(result); end
  % Load simulation data into MATLAB for plotting.
  load rtwdemo_rsimtf.mat;
  axis([0 1 0 2]);
  plot(rt_tout, rt_yout)
  hold on
end

 Run Batch Simulations Without Recompiling Generated Code

63-31



The plot shows 10 simulations, each using a different damping factor.

Step 5. Set Up a Time Vector and an Initial Frequency Vector

The time vector has 4096 points in the event we want to do windowing and spectral analysis on
simulation results.

dt = .001;
nn = [0:1:4095];
t = dt*nn; [m,n] = size(t);
wlo = 1; whi = 4;
omega = [wlo:((whi-wlo)/n):whi - (whi-wlo)/n];

Step 6. Create 5 Sets of Signal Data in MAT Files

Creating .mat files with chirp data.

disp('This part of the example illustrates a sequence of 5 plots. Each')
disp('plot shows an input chirp signal of certain frequency range.')
for i = 1:5
  wlo = whi; whi = 3*whi; % keep increasing frequencies
  omega = [wlo:((whi-wlo)/n):whi - (whi-wlo)/n];
  % In a real application we recommend shaping the chirp using
  % a windowing function (hamming or hanning window, etc.)
  % This example does not use a windowing function.
  u      = sin(omega.*t);
  tudata = [t;u];
  % At each pass, save one more set of tudata to the next
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  % .mat file.
  savestr = strcat('save sweep',num2str(i),'.mat tudata');
  eval(savestr);
  % Display each chirp. Note that this is only input data.
  % Simulations have not been run yet.
  plotstr = strcat('subplot(5,1,',num2str(i),');');
  eval(plotstr);
  plot(t,u)
  pause(0.3)
end

This part of the example illustrates a sequence of 5 plots. Each
plot shows an input chirp signal of certain frequency range.

Step 7. Run the RSim Compiled Simulation Using New Signal Data

Replace the original signal data (rsim_tfdata.mat) with the files sweep1.mat, sweep2.mat, and so on.

disp('Starting batch simulations.')
for i = 1:5
  % Bang out and run the next set of data with RSim
  runstr = ['.', filesep, 'rtwdemo_rsimtf -f rsim_tfdata.mat=sweep', ...
            num2str(i),'.mat -v -tf 4.096'];
  [status, result] = system(runstr);
  if status ~= 0, error(result); end
  % Load the data to MATLAB and plot the results.
  load rtwdemo_rsimtf.mat
  plotstr = strcat('subplot(5,1,',num2str(i),');');
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  eval(plotstr);
  plot(rt_tout, rt_yout); axis([0 4.1 -3 3]);
end
zoom on
% cleanup
evalin('base','clear w theta')
disp('This part of the example illustrates a sequence of 5 plots. Each plot')
disp('shows the simulation results for the next frequency range. Using the')
disp('mouse, zoom in on each signal to observe signal amplitudes.')
close_system(mdlName, 0);

Starting batch simulations.
This part of the example illustrates a sequence of 5 plots. Each plot
shows the simulation results for the next frequency range. Using the
mouse, zoom in on each signal to observe signal amplitudes.
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Use MAT-Files to Feed Data to Inport Blocks for Rapid
Simulations

This example shows how the code generator RSim -i option lets you use a MAT-file as the input data
source for Inport blocks for rapid simulations. The data in such a MAT-file can be presented in the
following formats:

• One variable that defines a time/input data matrix of double values.
• One variable that defines a structure that uses a combination of Simulink® data types.
• Multiple variables, each defining a structure that uses a combination of Simulink® data types.

This flexibility lends itself well to applications for which you must run simulations over a range of
input data stored in different data files. This example explains how to use this feature.

To quickly run multiple simulations in the Simulink environment, consider using rapid accelerator
instead of RSim. See “What Is Acceleration?”.

Prepare Model

Open the model and save a copy to a writable location. Then, open the Simulink Coder app. Set
model configuration parameter *System target file to rsim.tlc.

For more information on doing this graphically and setting up other model configuration parameters
relate to the RSim system target file, look here.

mdlName = 'rtwdemo_rsim_i';
open_system(mdlName);
cs = getActiveConfigSet(mdlName);
cs.switchTarget('rsim.tlc',[]);

Configure Inport Blocks

To use the RSim -i option, you must configure each Inport block properly. You can double-click an
Inport block to view its properties. By default, Inport blocks inherit their properties from downstream
blocks. Before you can import data from external MAT-files, you must set the parameters of each
Inport block to match the data in the MAT file. In most cases, these parameters of an Inport block
must be set:

• Interpolate Data
• Port Dimensions
• Data Type
• Signal Type

For more information on these parameters, click the Help button. This example model includes three
Inport blocks. A requirement for the example is for Inport 1 and Inport 2 to interpolate between data,
and for Inport 3 to not interpolate. The dimension of the Inport blocks are 2, 1, and 2, respectively.
Signals are real. The settings are as follows:

for i =1:3
    portName      =['/In', num2str(i)];
    Interp        = get_param(strcat(mdlName,portName),'Interpolate');
    PortDimension = get_param(strcat(mdlName,portName),'PortDimensions');
    DataType      = get_param(strcat(mdlName,portName),'OutDataTypeStr');
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    SignalType    = get_param(strcat(mdlName,portName),'SignalType');
end

• For inports In1 and In2, interpolation is selected. For inport In3, interpolation is cleared.
• For inports In1 and In3, port dimension is set to 2. For inport In2, port dimension is set to 1.
• For inports In1, In2, and In3, data type is double and signal type is real.

Build Model

Build an executable for the model. During the build process, a structural checksum is calculated and
embedded into the generated executable program. This checksum is used to check that a parameter
set passed to the executable program is compatible with the program.

evalc('slbuild(mdlName)');

Identify Signals for Data File

After you configure the Inport block, prepare the data file based on the Inport blocks. This figure
shows the input signals to be used.

t=[0:0.01:2*pi]';
s1 = [2*sin(t) 2*cos(t)];
s2 = sin(2*t);
s3 = [0.5*sin(3*t) 0.5*cos(3*t)];
figure;
plot(t, [s1 s2 s3]);
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This figure displays the input signals.

Prepare MAT-File

Generally, you can create the MAT-file from a workspace variable. The RSim -i option supports three
data file formats:

One variable in TU matrix format of doubles

For this format, the first column is the time vector and the remaining columns are input vectors. The
number of columns in the TU matrix equals the sum of the dimensions of the root Inport blocks plus
1. This MATLAB® code generates a MAT-file containing one variable var_matrix in TU matrix format.
You can use this format only if the input ports in the model have the same data type.

t=[0:0.1:2*pi]';
Ina1 = [2*sin(t) 2*cos(t)];
Ina2 = sin(2*t);
Ina3 = [0.5*sin(3*t) 0.5*cos(3*t)];
var_matrix = [t Ina1 Ina2 Ina3];
save rsim_i_matrix.mat var_matrix;

MAT-file rsim_i_matrix.mat contains one variable var_matrix in TU matrix format.

One variable in structure format

For this format, the variable must contain two fields: time and signals. If you set the block parameter
Interpolate data for one of the Inport blocks, the time field of the variable must not be an empty
vector and the width of the signals must equal the total width of the Inport blocks. This code
generates a MAT-file that contains one variable var_matrix in signal variable structure format. This
format is more flexible than the TU matrix format because it can support input ports with different
data types.

t= [0:0.1:2*pi]';
var_single_struct.time = t;
var_single_struct.signals(1).values(:,1) = 2*sin(t);
var_single_struct.signals(1).values(:,2) = 2*cos(t);
var_single_struct.signals(2).values = sin(2*t);
var_single_struct.signals(3).values(:,1) = 0.5*sin(3*t) ;
var_single_struct.signals(3).values(:,2) = 0.5*cos(3*t) ;
v=[var_single_struct.signals(1).values var_single_struct.signals(2).values ...
    var_single_struct.signals(3).values ];
save rsim_i_single_struct.mat var_single_struct;

MAT-file rsim_i_single_struct.mat contains one variable var_single_struct in struct
format.

Multiple variables in structure format

For this format, the number of variables equals the number of Inport blocks. Different variables can
have different time vectors. This code generates a MAT-file that contains multiple variables, each in
structure format. This is the most flexible format because it allows each Inport block to have its own
time vector.

t= [0:0.1:2*pi]';
Inb1.time = t;
Inb1.signals.values(:,1) = 2*sin(t);
Inb1.signals.values(:,2) = 2*cos(t);
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t= [0:0.2:2*pi]';
Inb2.time = t;
Inb2.signals.values(:,1) = sin(2*t);
t= [0:0.1:2*pi]';
Inb3.time =  t;
Inb3.signals.values(:,1) = 0.5*sin(3*t);
Inb3.signals.values(:,2) = 0.5*cos(3*t);
save rsim_i_multi_struct.mat Inb1;
save rsim_i_multi_struct.mat Inb2 -append;
save rsim_i_multi_struct.mat Inb3 -append;

MAT-file rsim_i_multi_struct.mat contains three variables Inb1, Inb2, and Inb3 in struct
format. Use the save command with the -append option to preserve the order of variables in the
generated MAT-file.

Run RSim Simulations and Plot Results

You can use RSim -i options for batch mode simulation. Prepare different MAT-files and run the RSim
program executable with them.

This part of the example shows three plots. Each plot shows simulation results for a MAT-file with a
different variable format. The model is compiled once.

figure
fileName = ({'rsim_i_matrix', 'rsim_i_single_struct', 'rsim_i_multi_struct'});
for i=1:3
    % bang out and run a simulation using new parameter data
    name = fileName(i);
    runstr = ['.', filesep, 'rtwdemo_rsim_i -i ',char(name),'.mat', ' -v'];
    evalc('system(runstr)');
    pause(0.5);
    % load simulation data into MATLAB(R) for plotting.
    load rtwdemo_rsim_i.mat;
    subplot(3,1,i);
    axis([0,6, -5, 5]);
    plot(rt_tout, rt_yout);
    hold on
end
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close_system(mdlName, 0);
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Accelerate Simulation, Reuse Code, or Protect Intellectual
Property by Using S-Function Target

S-functions are an important class of system target file for which the code generator can produce
code. The ability to encapsulate a subsystem into an S-function allows you to increase its execution
efficiency and facilitate code reuse.

The following sections describe the properties of S-function targets and illustrate how to generate
them. For more details on the structure of S-functions, see “C/C++ S-Function Basics”.

In this section...
“About the S-Function Target” on page 63-40
“Create S-Function Blocks from a Subsystem” on page 63-42
“Tunable Parameters in Generated S-Functions” on page 63-45
“System Target File” on page 63-46
“Checksums and the S-Function Target” on page 63-46
“Generated S-Function Compatibility” on page 63-47
“S-Function Target Limitations” on page 63-47

About the S-Function Target
Using the S-function target, you can build an S-function component and use it as an S-Function block
in another model. The following sections describe deployment considerations for the S-function
target.

• “Required Files for S-Function Deployment” on page 63-41
• “Sample Time Propagation in Generated S-Functions” on page 63-41
• “Choose a Solver Type” on page 63-42

The 'S-Function' value for CodeFormat TLC variable used by the S-function target generates
code that conforms to the Simulink C MEX S-function application programming interface (API).
Applications of this format include

• Conversion of a model to a component. You can generate an S-Function block for a model, m1.
Then, you can place the generated S-Function block in another model, m2. Regenerating code for
m2 does not require regenerating code for m1.

• Conversion of a subsystem to a component. By extracting a subsystem to a separate model and
generating an S-Function block from that model, you can create a reusable component from the
subsystem. See “Create S-Function Blocks from a Subsystem” on page 63-42 for an example of
this procedure.

• Speeding up simulation. Often, an S-function generated from a model performs more efficiently
than the original model.

• Code reuse. You can incorporate multiple instances of one model inside another without
replicating the code for each instance. Each instance continues to maintain its own unique data.

You can place a generated S-function block into another model from which you can generate another
S-function. This approach allows levels of nested S-functions. For limitations related to nesting, see
“Nesting S-Functions” on page 63-51.
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Note If you are generating code for a modeled software component, use a reference model instead of
generating an S-function block from a subsystem.

Note While you can use the S-function target to deploy an application component for reuse while
shielding its internal logic from inspection and modification, the preferred solutions for protecting
intellectual property in distributed components are:

• The protected model, a referenced model that hides block and line information. For more
information, see “Reference Protected Models from Third Parties”.

• The shared library system target file, used to generate a shared library for a model or subsystem
for use in a system simulation external to Simulink. For more information, see “Package
Generated Code as Shared Libraries” on page 64-2.

Required Files for S-Function Deployment

There are different files required to deploy a generated S-Function block for simulation versus code
generation.

To deploy your generated S-Function block for inclusion in other models for simulation, you need only
provide the binary MEX-file object that was generated in the current working folder when the S-
Function block was created. The required file is:

• subsys_sf.mexext

where subsys is the subsystem name and mexext is a platform-dependent MEX-file extension (see
mexext). For example, SourceSubsys_sf.mexw64.

To deploy your generated S-Function block for inclusion in other models for code generation, provide
the files that were generated in the current working folder when the S-Function block was created.
The required files are:

• subsys_sf.c or .cpp, where subsys is the subsystem name (for example,
SourceSubsys_sf.c)

• subsys_sf.h
• subsys_sf.mexext, where mexext is a platform-dependent MEX-file extension (see mexext)
• Subfolder subsys_sfcn_rtw and its contents

The generated S-function code uses Configuration Parameters > Hardware Implementation
parameter values that match the host system on which the function was built. When you use the S-
function in a model for code generation, make sure that these parameter values for the model match
the parameter values of the S-function.

Sample Time Propagation in Generated S-Functions

A generated S-Function block can inherit its sample time from the model in which it is placed if
certain criteria are met. Conditions that govern sample time propagation for both Model blocks and
generated S-Function blocks are described in “Referenced Model Sample Times” and “S-Functions
That Specify Sample Time Inheritance Rules” on page 13-81.

To generate an S-Function block that meets the criteria for inheriting sample time, you must
constrain the solver for the model from which the S-Function block is generated. Set model
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configuration parameter Type to Fixed-step and Periodic sample time constraint to Ensure
sample time independent. If the model is unable to inherit sample times, this setting causes the
Simulink software to display an error message when building the model. For more information about
this option, see “Periodic sample time constraint”.

Choose a Solver Type

The table shows the possible combinations of top-level model solver types as these types relate to
whether the model has discrete or continuous sample times and solver types for generated S-
functions.

Top-Level Model Solver Options and Sample Times

 Model Configuration Parameters: Top-level model
configuration

Sample Times Solver Options, Type:
Variable-step

Solver Options, Type: Fixed-
step

Discrete Generated S-function requires a
variable-step solver

Generated S-function can have a
variable-step solver or a fixed-

step solver
Continuous Generated S-function requires a

variable-step solver
Generated S-function requires a

fixed-step solver

S-functions generated from a subsystem have parameters that are hardcoded into the block. Simulink
calculates parameters such as sample time when it generates the block, not during simulation run
time. It is important to verify whether the generated S-Function block works as expected in the
destination model.

Create S-Function Blocks from a Subsystem
This section shows how to extract a subsystem from a model and generate a reusable S-function
component from it.

The next figure shows SourceModel, a simple model that inputs signals to a subsystem. The
subsequent figure shows the subsystem, SourceSubsys. The signals, which have different widths
and sample times, are:

• A Step block with sample time 1
• A Sine Wave block with sample time 0.5
• A Constant block whose value is the vector [-2 3]
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SourceModel

SourceSubsys

The objective is to extract SourceSubsys from the model and build an S-Function block from it,
using the S-function target. The S-Function block must perform identically to the subsystem from
which it was generated.

In this model, SourceSubsys inherits sample times and signal widths from its input signals.
However, S-Function blocks created from a model using the S-function target has all signal attributes
(such as signal widths or sample times) hard-wired. (The sole exception to this rule concerns sample
times, as described in “Sample Time Propagation in Generated S-Functions” on page 63-41.)

In this example, you want the S-Function block to retain the properties of SourceSubsys as it exists
in SourceModel. Therefore, before you build the subsystem as a separate S-function component, you
must set the inport sample times and widths explicitly. In addition, the solver parameters of the S-
function component must be the same as those parameters of the original model. The generated S-
function component operates identically to the original subsystem (see “Choose a Solver Type” on
page 63-42 for more information).

To build SourceSubsys as an S-function component,

1 Create a new model and copy/paste the SourceSubsys block into the empty window.
2 Set the signal widths and sample times of inports inside SourceSubsys such that they match

those of the signals in the original model. Inport 1, Filter, has a width of 1 and a sample time of
1. Inport 2, Xferfcn, has a width of 1 and a sample time of 0.5. Inport 3, offsets, has a width
of 2 and a sample time of 0.5.
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3 The generated S-Function block should have three inports and one outport. Connect inports and
an outport to SourceSubsys, as shown in the next figure.

The signal widths and sample times are propagated to these ports.
4 Set the solver type, mode, and other solver parameters such that they are identical to those of

the source model. This is easiest to do if you use Model Explorer.
5 Set model configuration parameter System target file to rtwsfcn.tlc.
6 Select the S-Function Target pane. Make sure that Create new model is selected, as shown in

the next figure:

When this option is selected, the build process creates a new model after it builds the S-function
component. The new model contains an S-Function block, linked to the S-function component.

Click Apply.
7 Save the new model containing your subsystem, for example as SourceSubsys.
8 Build the model.
9 The build process produces the S-function component in the working folder. After the build, a

new model window is displayed.

Optionally you can save the generated model, for example as SourceSubsys_Sfunction.
10 You can now copy the S-Function block generated from the new model and use it in other models

or in a library.

Note For a list of files required to deploy your S-Function block for simulation or code
generation, see “Required Files for S-Function Deployment” on page 63-41.
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The next figure shows the S-Function block plugged into the original model. Given identical input
signals, the S-Function block performs identically to the original subsystem.

Generated S-Function Configured Like SourceModel

The speed at which the S-Function block executes is typically faster than the original model. This
difference in speed is more pronounced for larger and more complicated models. By using generated
S-functions, you can increase the efficiency of your modeling process.

Tunable Parameters in Generated S-Functions
You can use tunable parameters in generated S-functions in two ways:

• Use the Generate S-function feature (see “Generate S-Function from Subsystem” on page 13-
64).

or
• Use the Model Parameter Configuration dialog box (see “Declare Workspace Variables as Tunable

Parameters Using the Model Parameter Configuration Dialog Box”) to declare desired block
parameters tunable.

Block parameters that you declare as tunable with the auto storage class in the source model
become tunable parameters of the generated S-function. These parameters do not become part of a
generated model_P (formerly rtP) parameter data structure, as they would in code generated from
other system target files. Instead, the generated code accesses these parameters by using MEX API
calls such as mxGetPr or mxGetData. Your code should access these parameters in the same way.

For more information on MEX API calls, see “About C MEX S-Functions” and “Choosing a MATLAB
API for Your Application”.

S-Function blocks created by using the S-function target are automatically masked. The mask
displays each tunable parameter in an edit field. By default, the edit field displays the parameter by
variable name, as in the following example.
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You can choose to display the value of the parameter rather than its variable name by selecting model
configuration parameter Use value for tunable parameters.

When select this parameter, the value of the variable (at code generation time) is displayed in the edit
field, as in the following example.

System Target File
The rtwsfcn.tlc system target file is provided for use with the S-function target.

Checksums and the S-Function Target
The code generator creates a checksum for a model and uses the checksum during the build process
for code reuse, model reference, and external mode features.
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The code generator calculates a model checksum by

1 Calculating a checksum for each subsystem in the model. A subsystem's checksum is the
combination of properties (data type, complexity, sample time, port dimensions, and so forth) of
the subsystem's blocks.

2 Combining the subsystem checksums and other model-level information.

An S-function can add additional information, not captured during the block property analysis, to a
checksum by calling the function ssSetChecksumVal. For the S-Function target, the value that gets
added to the checksum is the checksum of the model or subsystem from which the S-function is
generated.

The code generator applies the subsystem and model checksums as follows:

• Code reuse — If two subsystems in a model have the same checksum, the code generator
produces code for one function only.

• Model reference — If the current model checksum matches the checksum when the model was
built, the build process does not rebuild referenced models.

• External mode — If the current model checksum does not match the checksum of the code that is
running on the target hardware, the build process generates an error.

Generated S-Function Compatibility
When you build a MEX S-function from your model, the code generator builds a level 2 noninlined S-
function. Cross-release usage limitations on the generated code and binary MEX file (for example,
*.mexw64) include:

• S-function target generated code from previous MATLAB release software is not compatible with
newer releases. Do not recompile the generated code from a previous release with newer MATLAB
release software. Use the same MATLAB release software to generate code for the S-function
target and compile the code into a MEX file.

• You can use binary S-function MEX files generated from previous MATLAB release software with
the same or newer releases with the same compatibility considerations as handwritten S-
functions. For more information, see “S-Function Compatibility”.

• The code generator can generate code and build an executable from a model that contains
generated S-functions. This support requires that the S-functions are built with the same MATLAB
release software that builds the model. It is not possible to incorporate a generated S-function
MEX file from previous MATLAB release software into a model and build the model with newer
releases.

S-Function Target Limitations
• “Configuring Inport and Outport Blocks with Continuous Sample Time” on page 63-48
• “Using Tunable Variables in Expressions” on page 63-48
• “Parameter Tuning” on page 63-48
• “Run-Time Parameters and S-Function Compatibility Diagnostics” on page 63-48
• “Goto and From Block” on page 63-49
• “Building and Updating S-Functions” on page 63-50
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• “Unsupported Blocks” on page 63-50
• “SimState Not Supported for Code Generation” on page 63-50
• “Profiling Code Performance with TLC Hook Function Not Supported” on page 63-51
• “Nesting S-Functions” on page 63-51
• “User-Defined Data Types” on page 63-51
• “Right-Click Generation of an S-Function Target” on page 63-51
• “Bus I/O Signals” on page 63-51
• “Subsystems with Function-Call I/O Signals” on page 63-52
• “Function-Call Subsystem Modeling Pattern” on page 63-52
• “Data Store Access” on page 63-53
• “Cannot Specify Inport or Outport Block Parameters Through Subsystem Mask” on page 63-53

Configuring Inport and Outport Blocks with Continuous Sample Time

The right-click build method for generating an S-function does not preserve continuous sample time
for Inport and Outport blocks. Because the sample time is not preserved, simulation of the generated
S-Function block can be affected.

Using Tunable Variables in Expressions

Certain limitations apply to the use of tunable variables in expressions. When the code generator
encounters an unsupported expression while producing code, a warning appears and the equivalent
numeric value is generated in the code. For a list of the limitations, see “Tunable Expression
Limitations” on page 34-120.

Parameter Tuning

The S-Function block does not support tuning of tunable parameters with:

• Complex values.
• Values or data types that are transformed to a constant (by setting the model configuration

parameter Optimization > Default parameter behavior to Inlined).
• Data types that are not built-in.
• Floating-point data types that are not equivalent to a built-in type.

If you select these tunable parameters (through the Generate S-Function for Subsystem dialog box):

• The software produces warnings during the build process.
• The generated S-Function block mask does not display these parameters.

Run-Time Parameters and S-Function Compatibility Diagnostics

If you set model configuration parameter S-function upgrades needed to warning or error, the
code generator instructs you to upgrade S-functions that you create with the Generate S-function
feature. This is because the S-function system target file does not register run-time parameters. Run-
time parameters are only supported for inlined S-Functions and the generated S-Function supports
features that prevent it from being inlined (for example, it can call or contain other noninlined S-
functions).

You can work around this limitation by setting parameter S-function upgrades needed to none.
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Goto and From Block

When using the S-function system target file, the code generator restricts I/O to correspond to the
root model Inport and Outport blocks (or the Inport and Outport blocks of the Subsystem block from
which the S-function target was generated). The code generator does not produce code for Goto or
From blocks.

To work around this restriction, create your model and subsystem with the required Inport and
Outport blocks, instead of using Goto and From blocks to pass data between the root model and
subsystem. In the model that incorporates the generated S-function, you would then add Goto and
From blocks.

Example Before Work Around

• Root model with a From block and subsystem, Subsystem1

• Subsystem1 with a Goto block, which has global visibility and passes its input to the From block
in the root model

• Subsystem1 replaced with an S-function generated with the S-Function target — a warning
results when you run the model because the generated S-function does not implement the Goto
block

Example After Work Around

An Outport block replaces the GoTo block in Subsystem1. When you plug the generated S-function
into the root model, its output connects directly to the To Workspace block.
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Building and Updating S-Functions

The following limitations apply to building and updating S-functions using the S-function system
target file:

• You cannot build models that contain Model blocks using the S-function system target file. This
also means that you cannot build a subsystem by using the right-click context menu if the
subsystem contains Model blocks. This restriction applies only to S-functions generated using the
S-function target, not to ERT S-functions.

• You can build a model with:

• A toolchain only if the toolchain supports MEX-file generation.
• A template makefile only if the template makefile is associated with a toolchain on page 57-17

that supports MEX-file generation.
• If you modify the model that generated an S-Function block, the build process does not

automatically rebuild models containing the generated S-Function block. This is in contrast to the
practice of automatically rebuilding models referenced by Model blocks when they are modified
(depending on the Model Reference Rebuild configuration setting).

• Handwritten S-functions without corresponding TLC files must contain exception-free code. For
more information on exception-free code, see “Exception Free Code”.

Unsupported Blocks

The S-function format does not support the following built-in blocks:

• Interpreted MATLAB Function block
• S-Function blocks containing any of the following:

• MATLAB language S-functions (unless you supply a TLC file for C code generation)
• Fortran S-functions (unless you supply a TLC file for C code generation)
• C/C++ MEX S-functions that call into the MATLAB environment

• Scope block
• To Workspace block

The S-function format does not support blocks from the embeddedtargetslib block library.

SimState Not Supported for Code Generation

You can use SimState within C-MEX and Level-2 MATLAB language S-functions to save and restore
the simulation state. See “S-Function Compliance with the ModelOperatingPoint”. However,
SimState is not supported for code generation, including with the S-function system target file.
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Profiling Code Performance with TLC Hook Function Not Supported

Profiling the performance of generated code using the Target Language Compiler (TLC) hook
function interface described in “Profile Code Execution Speed” is not supported for the S-function
target.

Note If you have an Embedded Coder license, see “Code Execution Profiling” for an alternative and
simpler approach based on software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulations.

Nesting S-Functions

The following limitations apply to nesting a generated S-Function block in a model or subsystem from
which you generate another S-function:

• The software does not support nonvirtual bus input and output signals for a nested S-function.
• Avoid nesting an S-function in a model or subsystem having the same name as the S-function

(possibly several levels apart). In such situations, the S-function can be called recursively. The
software currently does not detect such loops in S-function dependency, which can result in
aborting or hanging your MATLAB session. To prevent this from happening, name the subsystem
or model to be generated as an S-function target uniquely to avoid duplicating existing MEX
filenames on the MATLAB path.

User-Defined Data Types

The S-function system target file does not support the HeaderFile property that can be specified on
user-defined data types, including those based on Simulink.AliasType, Simulink.Bus, and
Simulink.NumericType objects. If a user-defined data type in your model uses the HeaderFile
property to specify an associated header file, code generation with the S-function system target file
disregards the value and does not generate a corresponding include statement.

Right-Click Generation of an S-Function Target

If you generate an S-function target by right-clicking a Function-Call Subsystem block, the original
subsystem and the generated S-function might not be consistent. An inconsistency occurs when the
States when enabling parameter of the Trigger Port block inside the Function-Call Subsystem block
is set to inherit. You must set the States when enabling parameter to reset or held, otherwise
Simulink reports an error.

Bus I/O Signals

If an S-function generated using the S-function target has bus input or output signals, the generated
bus data structures might include padding to align fields of the bus elements with the Simulink
representation used during simulation. However, if you insert the S-function in a model and generate
code using a model target such as grt.tlc, the bus structure alignment generated for the model
build might be incompatible with the padding generated for the S-function and might impact the
numerical results of code execution. To make the structure alignment consistent between model
simulation and execution of the model code, for each Simulink.Bus object, you can modify the
HeaderFile property to remove the unpadded bus structure header file. This will cause the bus
typedefs generated for the S-function to be reused in the model code.
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Subsystems with Function-Call I/O Signals

The S-function target does not support creating an S-Function block from a subsystem that has a
function-call trigger input or a function-call output.

Function-Call Subsystem Modeling Pattern

If a model includes this function-call subsystem modeling pattern, you must insert a Signal
Conversion block.

The function-call subsystem connects directly to an Outport block and the signal line that connects
the subsystem to the Outport block branches to a block that has an Update function (block that
updates at each major time step, such as Unit Delay and Memory). The branch can be inside or
outside of the subsystem. In the model that includes the function-call subsystem, you must insert a
Signal Conversion block in one of these locations:

1 Between the subsystem block and the branch
2 Between the branch and the root Outport block
3 Between the branch and the block that has the Update function

Before generating the S-Function block for the subsystem, set these Signal Conversion block
parameters:

• Set Output to Signal copy
• Select Exclude this bock from 'Block reduction' optimization

If you do not apply the workaround, when you add the generated S-Function block to a model and
then simulate that model, MATLAB might crash.

63 Desktops in Simulink Coder

63-52



Data Store Access

When an S-Function in your model accesses a data store during simulation, Simulink disables data
store diagnostics.

• If you created the S-Function from a model, the diagnostic is disabled for global data stores as
well.

• If you created the S-Function from a subsystem, the diagnostic is disabled for the following data
stores:

• Global data stores
• Data stores placed outside the subsystem, but accessed by Data Store Read or Data Store

Write blocks.

Cannot Specify Inport or Outport Block Parameters Through Subsystem Mask

You cannot specify Inport or Outport block parameters by using subsystem mask variables if you want
to generate an S-Function block from the subsystem. The software produces an error when you try to
run a simulation that uses the S-Function block, for example:

Invalid setting in 'testSystem/Subsystem/__OutputSSForSFun__/Out2' 
for parameter 'PortDimensions'
...

See Also

More About
• “Acceleration”
• “Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System

Target File”
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Package Generated Code as Shared Libraries
If you have an Embedded Coder license, you can package generated source code from a model
component for easy distribution and shared use by building the code as a shared library—Windows
dynamic link library (.dll), UNIX shared object (.so), or Macintosh OS X dynamic library (.dylib).
You or others can integrate the shared library into an application that runs on a Windows, UNIX, or
Macintosh OS X development computer. The generated .dll, .so, or .dylib file is shareable among
different applications and upgradeable without having to recompile the applications that use it.

About Generated Shared Libraries
You build a shared library by configuring the code generator to use the system target file
ert_shrlib.tlc. Code generation for that system target file exports:

• Variables and signals of type ExportedGlobal as data
• Real-time model structure (model_M) as data
• Functions essential to executing your model code

To view a list of symbols contained in a generated shared library:

• On Windows, use the Dependency Walker utility, downloadable from http://
www.dependencywalker.com

• On UNIX, use nm -D model.so
• On Macintosh OS X , use nm -g model.dylib

To generate and use a shared library:

1 Generate a shared library version of your model code
2 Create application code to load and use your shared library file

Generate Shared Library Version of Model Code
To generate a shared library version of your model code:

1 Open your model and configure it to use the ert_shrlib.tlc system target file.

Selecting the ert_shrlib.tlc system target file causes the build process to generate a shared
library version of your model code into your current working folder. The selection does not
change the code that the code generator produces for your model.

2 Build the model.
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3 After the build completes, examine the generated code in the model subfolder and examine
the .dll, .so, or .dylib file in your current folder.

Create Application Code to Use Shared Library
To illustrate how application code can load a shared library file and access its functions and data,
MathWorks provides the model rtwdemo_shrlib.

Note Navigate to a writable working folder before running the rtwdemo_shrlib script.

In the model, click the blue button to run a script. The script:

1 Builds a shared library file from the model (for example, rtwdemo_shrlib_win64.dll on 64-
bit Windows).

2 Compiles and links an example application, rtwdemo_shrlib_app, that loads and uses the
shared library file.

3 Executes the example application.

Tip Explicit linking is preferred for portability. However, on Windows systems, the ert_shrlib
system target file generates and retains the .lib file to support implicit linking.

To use implicit linking, the generated header file needs a small modification for you to use it with the
generated C file. For example, if you are using Visual C++, declare __declspec(dllimport) in
front of data to be imported implicitly from the shared library file.

The model uses the following example application files, which are located in the folder matlabroot/
toolbox/rtw/rtwdemos/shrlib_demo (open).

File Description
rtwdemo_shrlib_app.h Example application header file
rtwdemo_shrlib_app.c Example application that loads and uses the shared

library file generated for the model
run_rtwdemo_shrlib_app.m Script to compile, link, and execute the example

application

You can view each of these files by clicking white buttons in the model window. Additionally, running
the script places the relevant source and generated code files in your current folder. The files can be
used as templates for writing application code for your own ERT shared library files.

The following sections present key excerpts of the example application files.

Example Application Header File

The example application header file rtwdemo_shrlib_app.h contains type declarations for the
model's external input and output.
#ifndef _APP_MAIN_HEADER_
#define _APP_MAIN_HEADER_
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typedef struct {
    int32_T Input;
} ExternalInputs_rtwdemo_shrlib;

typedef struct {
    int32_T Output;
} ExternalOutputs_rtwdemo_shrlib;

#endif /*_APP_MAIN_HEADER_*/

Example Application C Code

The example application rtwdemo_shrlib_app.c includes the following code for dynamically
loading the shared library file. Notice that, depending on platform, the code invokes Windows or
UNIX library commands.
#if (defined(_WIN32)||defined(_WIN64)) /* WINDOWS */
#include <windows.h>
#define GETSYMBOLADDR GetProcAddress
#define LOADLIB LoadLibrary
#define CLOSELIB FreeLibrary

#else /* UNIX */
#include <dlfcn.h>
#define GETSYMBOLADDR dlsym
#define LOADLIB dlopen
#define CLOSELIB dlclose

#endif

int main()
{
    void* handleLib;
...
#if defined(_WIN64)
    handleLib = LOADLIB("./rtwdemo_shrlib_win64.dll");
#else
#if defined(_WIN32)
    handleLib = LOADLIB("./rtwdemo_shrlib_win32.dll");
#else /* UNIX */
    handleLib = LOADLIB("./rtwdemo_shrlib.so", RTLD_LAZY);
#endif
#endif
...
    return(CLOSELIB(handleLib));
}

The following code excerpt shows how the C application accesses the model's exported data and
functions. Notice the hooks for adding user-defined initialization, step, and termination code.
    int32_T i;
 ...
    void (*mdl_initialize)(boolean_T);
    void (*mdl_step)(void);
    void (*mdl_terminate)(void);

    ExternalInputs_rtwdemo_shrlib (*mdl_Uptr);
    ExternalOutputs_rtwdemo_shrlib (*mdl_Yptr);
        
    uint8_T (*sum_outptr);
...
#if (defined(LCCDLL)||defined(BORLANDCDLL))
    /* Exported symbols contain leading underscores when DLL is linked with
       LCC or BORLANDC */
    mdl_initialize =(void(*)(boolean_T))GETSYMBOLADDR(handleLib ,
                     "_rtwdemo_shrlib_initialize");
    mdl_step       =(void(*)(void))GETSYMBOLADDR(handleLib ,
                     "_rtwdemo_shrlib_step");
    mdl_terminate  =(void(*)(void))GETSYMBOLADDR(handleLib ,
                     "_rtwdemo_shrlib_terminate");
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    mdl_Uptr       =(ExternalInputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
                     "_rtwdemo_shrlib_U");
    mdl_Yptr       =(ExternalOutputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
                     "_rtwdemo_shrlib_Y");
    sum_outptr     =(uint8_T*)GETSYMBOLADDR(handleLib , "_sum_out");
#else   
    mdl_initialize =(void(*)(boolean_T))GETSYMBOLADDR(handleLib ,
                     "rtwdemo_shrlib_initialize");
    mdl_step       =(void(*)(void))GETSYMBOLADDR(handleLib ,
                     "rtwdemo_shrlib_step");
    mdl_terminate  =(void(*)(void))GETSYMBOLADDR(handleLib ,
                     "rtwdemo_shrlib_terminate");
    mdl_Uptr       =(ExternalInputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
                     "rtwdemo_shrlib_U");
    mdl_Yptr       =(ExternalOutputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
                     "rtwdemo_shrlib_Y");
    sum_outptr     =(uint8_T*)GETSYMBOLADDR(handleLib , "sum_out");
#endif
    
    if ((mdl_initialize && mdl_step && mdl_terminate && mdl_Uptr && mdl_Yptr && 
         sum_outptr)) {
        /* === user application initialization function === */
        mdl_initialize(1); 
        /* insert other user defined application initialization code here */
        
        /* === user application step function === */
        for(i=0;i<=12;i++){ 
            mdl_Uptr->Input = i;
            mdl_step(); 
            printf("Counter out(sum_out): %d\tAmplifier in(Input): %d\tout(Output): %d\n",
                   *sum_outptr, i, mdl_Yptr->Output); 
            /* insert other user defined application step function code here */
        }
        
        /* === user application terminate function === */
        mdl_terminate();
        /* insert other user defined application termination code here */
    }
    else {
        printf("Cannot locate the specified reference(s) in the shared library.\n");
        return(-1);
    }

Example Application Script

The application script run_rtwdemo_shrlib_app loads and rebuilds the model, and then compiles,
links, and executes the model's shared library target file. You can view the script source file by
opening rtwdemo_shrlib and clicking a white button to view source code. The script constructs
platform-dependent command character vectors for compilation, linking, and execution that may
apply to your development environment. To run the script, click the blue button.

Note To run the run_rtwdemo_shrlib_app script without first opening the rtwdemo_shrlib
model, navigate to a writable working folder and issue the following MATLAB command:

addpath(fullfile(matlabroot,'toolbox','rtw','rtwdemos','shrlib_demo'))

Note It is invalid to invoke the terminate function twice in a row. The terminate function clears
pointers and sets them to NULL. Invoking the function a second time dereferences null pointers and
results in a program failure.
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Shared Library Limitations
The following limitations apply to building shared libraries:

• Code generation for the ert_shrlib.tlc system target file exports the following as data:

• Variables and signals of type ExportedGlobal
• Real-time model structure (model_M)

• For a model that contains a function-call subsystem, code generation for the ert_shrlib.tlc
system target file exports to the shared library only symbols associated with the initialize and
terminate entry-point functions.

• Code generation for the ert_shrlib.tlc system target file supports the C language only (not C
++). When you select ert_shrlib.tlc, model configuration parameter Language is greyed out.

• To reconstruct a model simulation using a generated shared library, the application author must
maintain the timing between system and shared library function calls in the original application.
The timing needs to be consistent so that you can compare the simulation and integration results.
Additional simulation considerations apply if generating a shared library from a model that
enables model configuration parameters Support: continuous time and Single output/update
function. For more information, see “Single output/update function” dependencies.

See Also

More About
• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “Configure a System Target File” on page 48-2
• “Model Protection”
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Real-Time Systems in Simulink Coder

• “Deploy Algorithm Model for Real-Time Rapid Prototyping” on page 65-2
• “Deploy Environment Model for Real-Time Hardware-In-the-Loop (HIL) Simulation”

on page 65-4
• “Untrusted Custom Code, Custom Targets, and Callbacks” on page 65-6
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Deploy Algorithm Model for Real-Time Rapid Prototyping
Use the code generator to deploy algorithm models for real-time rapid prototyping.

About Real-Time Rapid Prototyping
Real-time rapid prototyping requires the use of a real-time simulator, potentially connected to system
hardware (for example, physical plant or vehicle) being controlled. You generate, deploy, and tune
code as it runs on the real-time simulator or embedded microprocessor. This design step is crucial for
verifying whether a component can adequately control the system, and allows you to assess, interact
with, and optimize code.

The following figure shows a typical approach for real-time rapid prototyping.

Goals of Real-Time Rapid Prototyping
Assuming that you have documented functional requirements, refined concept models, system
hardware for the physical plant or vehicle being controlled, and access to target products you intend
to use (for example, for example, the Simulink Real-Time or Simulink Desktop Real-Time product),
you can use real-time prototyping to:

• Refine component and environment model designs by rapidly iterating between algorithm design
and prototyping

• Validate whether a component can adequately control the physical system in real time
• Evaluate system performance before laying out hardware, coding production software, or

committing to a fixed design
• Test hardware

Refine Code With Real-Time Rapid Prototyping
To perform real-time rapid prototyping:

1 Create or acquire a real-time system that runs in real time on rapid prototyping hardware. The
Simulink Real-Time product facilitates real-time rapid prototyping. This product provides a real-

65 Real-Time Systems in Simulink Coder

65-2

https://www.mathworks.com/products/simulink-real-time.html
https://www.mathworks.com/products/simulink-desktop-real-time.html
https://www.mathworks.com/products/simulink-real-time.html


time operating system that makes PCs run in real time. It also provides device driver blocks for
numerous hardware I/O cards. You can then create a rapid prototyping system using inexpensive
commercial-off-the-shelf (COTS) hardware. In addition, third-party vendors offer products based
on the Simulink Real-Time product or other code generation technology that you can integrate
into a development environment.

2 Use provided system target files to generate code that you can deploy onto a real-time simulator.
See the following information.

Engineering Tasks Related Product Information Examples
Generate code for real-time rapid
prototyping

“Compare System Target File
Support Across Products”

“Event-Based Scheduling”

Embedded Coder

“Support for Standards and
Guidelines” on page 23-2

rtwdemo_counter
rtwdemo_counter_msvc

Generate code for rapid
prototyping in hard real time,
using PCs

Simulink Real-Time

“Simulink Real-Time Options
Pane” (Simulink Real-Time)

slrt_ex_osc (and others)

Generate code for rapid
prototyping in soft real time, using
PCs

Simulink Desktop Real-Time

“Simulink Desktop Real-Time
Pane” (Simulink Desktop Real-
Time)

sldrtex_vdp (and others)

3 Monitor signals, tune parameters, and log data.

See Also

More About
• “Access Signal, State, and Parameter Data During Execution” on page 34-17
• “Real-Time Simulation and Testing” (Simulink Real-Time)
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Deploy Environment Model for Real-Time Hardware-In-the-Loop
(HIL) Simulation

In this section...
“About Hardware-In-the-Loop Simulation” on page 65-4
“Set Up and Run HIL Simulations” on page 65-4

About Hardware-In-the-Loop Simulation
Hardware-in-the-loop (HIL) simulation tests and verifies an embedded system or control unit in the
context of a software test platform. Examples of test platforms include real-time target systems and
instruction set simulators (IISs). You use Simulink software to develop and verify a model that
represents the test environment. Using the code generator, you produce, build, and download an
executable program for the model to the HIL simulation platform. After you set up the environment,
you can run the executable to validate the embedded system or control unit in real time.

During HIL simulation, you gradually replace parts of a system environment with hardware
components as you refine and fabricate the components. HIL simulation offers an efficient design
process that eliminates costly iterations of part fabrication.

The code that you build for the system simulator provides real-time system capabilities. For example,
the code can include VxWorks from Wind River or another real-time operating system (RTOS).

The following figure shows a typical HIL setup.

The HIL platform available from MathWorks is the Simulink Real-Time product. Several third-party
products are also available for use as HIL platforms. The Simulink Real-Time product offers hard real-
time performance for PCs with Intel or AMD® 32-bit processors functioning as your real-time target.
The Simulink Real-Time product enables you to add I/O interface blocks to your models and
automatically generate code with code generation technology. The Simulink Real-Time product can
download the code to a second PC running the Simulink Real-Time real-time kernel. System
integrator solutions that are based on Simulink Real-Time are also available.

Set Up and Run HIL Simulations
To set up and run HIL simulations iterate through the following steps:
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1 Develop a model that represents the environment or system under development.

For more information, see “Compare System Target File Support Across Products”.
2 Generate an executable for the environment model.
3 Download the executable for the environment model to the HIL simulation platform.
4 Replace software representing a system component with corresponding hardware.
5 Test the hardware in the context of the HIL system.
6 Repeat steps 4 and 5 until you can simulate the system after including components that require

testing.

See Also

More About
• “Access Signal, State, and Parameter Data During Execution” on page 34-17
• “Real-Time Simulation and Testing” (Simulink Real-Time)
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Untrusted Custom Code, Custom Targets, and Callbacks
You can use custom code in:

• Simulations on your development computer.
• Applications that you deploy on external hardware.

Untrusted custom code, custom targets, or callbacks have risks. For example, unintended
modification of your design, unauthorized acquisition of sensitive code and data by third parties, and
unapproved destruction of data.

Best practices for exchanging sensitive code and data with a supplier or customer are:

• For code packaging, use a secure container that supports encryption such as an Open Packaging
Conventions (OPC) container.

• For file transfer, use a secure transfer protocol such as HTTPS or SFTP.
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Real-Time and Embedded Systems in
Embedded Coder

• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Generate Main Program for Deployment to Bare Board Target” on page 66-24
• “Deploy Generated Component Software to Application Target Platforms” on page 66-26
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Deploy Generated Standalone Executable Programs To Target
Hardware

By default, the Embedded Coder software generates standalone executable programs that do not
require an external real-time executive or operating system. A standalone program requires minimal
modification to be adapted to the target hardware. The standalone program architecture supports
execution of models with either single or multiple sample rates.

In this section...
“Generate a Standalone Program” on page 66-2
“Standalone Program Components” on page 66-2
“Main Program” on page 66-3
“rt_OneStep and Scheduling Considerations” on page 66-4
“Static Main Program Module” on page 66-8
“Rate Grouping Compliance and Compatibility Issues” on page 66-13
“Generate Code That Dereferences Data from a Literal Memory Address” on page 66-16

Generate a Standalone Program
To generate a standalone program:

1 Select the model configuration parameter Generate an example main program. This enables
the Target operating system menu.

2 From the Target operating system menu, select BareBoardExample.
3 Generate code.

Different code is generated for multirate models depending on these factors:

• Whether the model executes in single-tasking or multitasking mode.
• Whether or not reusable code is being generated.

These factors can impact the scheduling algorithms used in generated code, and in some cases
impact the API for the model entry-point functions. The following sections discuss these variants.

Standalone Program Components
The core of a standalone program is the main loop. On each iteration, the main loop executes a
background or null task and checks for a termination condition.

The main loop is periodically interrupted by a timer. The function rt_OneStep is either installed as a
timer interrupt service routine (ISR), or called from a timer ISR at each clock step.

The execution driver, rt_OneStep, sequences calls to the model_step functions. The operation of
rt_OneStep differs depending on whether the generating model is single-rate or multirate. In a
single-rate model, rt_OneStep simply calls the model_step function. In a multirate model,
rt_OneStep prioritizes and schedules execution of blocks according to the rates at which they run.
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Main Program
• “Overview of Operation” on page 66-3
• “Guidelines for Modifying the Main Program” on page 66-3

Overview of Operation

The following pseudocode shows the execution of a main program.

main()
{
  Initialization (including installation of rt_OneStep as an 
    interrupt service routine for a real-time clock)
  Initialize and start timer hardware
  Enable interrupts
  While(not Error) and (time < final time)
    Background task
  EndWhile
  Disable interrupts (Disable rt_OneStep from executing)
  Complete any background tasks
  Shutdown
}

The pseudocode is a design for a harness program to drive your model. The main program only
partially implements this design. You must modify it according to your specifications.

Guidelines for Modifying the Main Program

This section describes the minimal modifications you should make in your production version of the
main program module to implement your harness program.

1 Call model_initialize.
2 Initialize target-specific data structures and hardware, such as ADCs or DACs.
3 Install rt_OneStep as a timer ISR.
4 Initialize timer hardware.
5 Enable timer interrupts and start the timer.

Note rtModel is not in a valid state until model_initialize has been called. Servicing of
timer interrupts should not begin until model_initialize has been called.

6 Optionally, insert background task calls in the main loop.
7 On termination of the main loop (if applicable):

• Disable timer interrupts.
• Perform target-specific cleanup such as zeroing DACs.
• Detect and handle errors. Note that even if your program is designed to run indefinitely, you

may need to handle severe error conditions, such as timer interrupt overruns.

You can use the macros rtmGetErrorStatus and rtmSetErrorStatus to detect and signal
errors.
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rt_OneStep and Scheduling Considerations
• “Overview of Operation” on page 66-4
• “Single-Rate Single-Tasking Operation” on page 66-4
• “Multirate Multitasking Operation” on page 66-5
• “Multirate Single-Tasking Operation” on page 66-7
• “Guidelines for Modifying rt_OneStep” on page 66-7

Overview of Operation

The operation of rt_OneStep depends upon

• Whether your model is single-rate or multirate. In a single-rate model, the sample times of all
blocks in the model, and the model's fixed step size, are the same. A model in which the sample
times and step size do not meet these conditions is termed multirate.

• Your model's solver mode (SingleTasking versus MultiTasking)

Permitted Solver Modes for Embedded Real-Time System Target Files summarizes the permitted
solver modes for single-rate and multirate models. Note that for a single-rate model, only
SingleTasking solver mode is allowed.

Permitted Solver Modes for Embedded Real-Time System Target Files

Mode Single-Rate Multirate
SingleTasking Allowed Allowed
MultiTasking Disallowed Allowed
Auto Allowed

(defaults to
SingleTasking)

Allowed

(defaults to MultiTasking)

The generated code for rt_OneStep (and associated timing data structures and support functions) is
tailored to the number of rates in the model and to the solver mode. The following sections discuss
each possible case.

Single-Rate Single-Tasking Operation

The only valid solver mode for a single-rate model is SingleTasking. Such models run in “single-
rate” operation.

The following pseudocode shows the design of rt_OneStep in a single-rate program.

rt_OneStep()
{
  Check for interrupt overflow or other error
  Enable "rt_OneStep" (timer) interrupt
  Model_Step()  -- Time step combines output,logging,update
}

For the single-rate case, the generated model_step function is

void model_step(void)
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Single-rate rt_OneStep is designed to execute model_step within a single clock period. To enforce
this timing constraint, rt_OneStep maintains and checks a timer overrun flag. On entry, timer
interrupts are disabled until the overrun flag and other error conditions have been checked. If the
overrun flag is clear, rt_OneStep sets the flag, and proceeds with timer interrupts enabled.

The overrun flag is cleared only upon successful return from model_step. Therefore, if rt_OneStep
is reinterrupted before completing model_step, the reinterruption is detected through the overrun
flag.

Reinterruption of rt_OneStep by the timer is an error condition. If this condition is detected
rt_OneStep signals an error and returns immediately. (Note that you can change this behavior if you
want to handle the condition differently.)

Note that the design of rt_OneStep assumes that interrupts are disabled before rt_OneStep is
called. rt_OneStep should be noninterruptible until the interrupt overflow flag has been checked.

Multirate Multitasking Operation

In a multirate multitasking system, code generation uses a prioritized, preemptive multitasking
scheme to execute the different sample rates in your model.

The following pseudocode shows the design of rt_OneStep in a multirate multitasking program.

rt_OneStep()
{
  Check for base-rate interrupt overrun
  Enable "rt_OneStep" interrupt
  Determine which rates need to run this time step

  Model_Step0()        -- run base-rate time step code

  For N=1:NumTasks-1   -- iterate over sub-rate tasks
    If (sub-rate task N is scheduled)
    Check for sub-rate interrupt overrun
      Model_StepN()    -- run sub-rate time step code
    EndIf
  EndFor
}

Task Identifiers

The execution of blocks having different sample rates is broken into tasks. Each block that executes
at a given sample rate is assigned a task identifier (tid), which associates it with a task that executes
at that rate. Where there are NumTasks tasks in the system, the range of task identifiers is
0..NumTasks-1.

Prioritization of Base-Rate and Subrate Tasks

Tasks are prioritized, in descending order, by rate. The base-rate task is the task that runs at the
fastest rate in the system (the hardware clock rate). The base-rate task has highest priority (tid 0).
The next fastest task (tid 1) has the next highest priority, and so on down to the slowest, lowest
priority task (tid NumTasks-1).

The slower tasks, running at multiples of the base rate, are called subrate tasks.
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Rate Grouping and Rate-Specific model_step Functions

In a single-rate model, the block output computations are performed within a single function,
model_step. For multirate, multitasking models, the code generator tries to use a different strategy.
This strategy is called rate grouping. Rate grouping generates separate model_step functions for
the base rate task and each subrate task in the model. The function naming convention for these
functions is

model_stepN

where N is a task identifier. For example, for a model named my_model that has three rates, the
following functions are generated:

void my_model_step0 (void);
void my_model_step1 (void);
void my_model_step2 (void);

Each model_stepN function executes the blocks sharing tid N; in other words, the block code that
executes within task N is grouped into the associated model_stepN function.

Scheduling model_stepN Execution

On each clock tick, rt_OneStep maintains scheduling counters and event flags for each subrate task.
The counters are implemented as taskCounter arrays indexed on tid. The event flags are
implemented as arrays indexed on tid.

The scheduling counters and task flags for sub-rates are maintained by rt_OneStep. The scheduling
counters are basically clock rate dividers that count up the sample period associated with each sub-
rate task. A pair of tasks that exchanges data maintains an interaction flag at the faster rate. Task
interaction flags indicate that both fast and slow tasks are scheduled to run.

The event flags indicate whether or not a given task is scheduled for execution. rt_OneStep
maintains the event flags based on a task counter that is maintained by code in the main program
module for the model. When a counter indicates that a task's sample period has elapsed, the main
code sets the event flag for that task.

On each invocation, rt_OneStep updates its scheduling data structures and steps the base-rate task
(rt_OneStep calls model_step0 because the base-rate task must execute on every clock step).
Then, rt_OneStep iterates over the scheduling flags in tid order, unconditionally calling
model_stepN for any task whose flag is set. The tasks are executed in order of priority.

Preemption

Note that the design of rt_OneStep assumes that interrupts are disabled before rt_OneStep is
called. rt_OneStep should be noninterruptible until the base-rate interrupt overflow flag has been
checked (see pseudocode above).

The event flag array and loop variables used by rt_OneStep are stored as local (stack) variables.
Therefore, rt_OneStep is reentrant. If rt_OneStep is reinterrupted, higher priority tasks preempt
lower priority tasks. Upon return from interrupt, lower priority tasks resume in the previously
scheduled order.

Overrun Detection

Multirate rt_OneStep also maintains an array of timer overrun flags. rt_OneStep detects timer
overrun, per task, by the same logic as single-rate rt_OneStep.
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Note If you have developed multirate S-functions, or if you use a customized static main program
module, see “Rate Grouping Compliance and Compatibility Issues” on page 66-13 for information
about how to adapt your code for rate grouping compatibility. This adaptation lets your multirate,
multitasking models generate more efficient code.

Multirate Single-Tasking Operation

In a multirate single-tasking program, by definition, sample times in the model must be an integer
multiple of the model's fixed-step size.

In a multirate single-tasking program, blocks execute at different rates, but under the same task
identifier. The operation of rt_OneStep, in this case, is a simplified version of multirate multitasking
operation. Rate grouping is not used. The only task is the base-rate task. Therefore, only one
model_step function is generated:

void model_step(void)

On each clock tick, rt_OneStep checks the overrun flag and calls model_step. The scheduling
function for a multirate single-tasking program is rate_scheduler (rather than
rate_monotonic_scheduler). The scheduler maintains scheduling counters on each clock tick.
There is one counter for each sample rate in the model. The counters are implemented in an array
(indexed on tid) within the Timing structure within rtModel.

The counters are clock rate dividers that count up the sample period associated with each subrate
task. When a counter indicates that a sample period for a given rate has elapsed, rate_scheduler
clears the counter. This condition indicates that blocks running at that rate should execute on the
next call to model_step, which is responsible for checking the counters.

Guidelines for Modifying rt_OneStep

rt_OneStep does not require extensive modification. The only required modification is to reenable
interrupts after the overrun flags and error conditions have been checked. If applicable, you should
also

• Save and restore your FPU context on entry and exit to rt_OneStep.
• Set model inputs associated with the base rate before calling model_step0.
• Get model outputs associated with the base rate after calling model_step0.

Note If you modify rt_OneStep to read a value from a continuous output port after each base-
rate model step, see the relevant cautionary guideline below.

• In a multirate, multitasking model, set model inputs associated with subrates before calling
model_stepN in the subrate loop.

• In a multirate, multitasking model, get model outputs associated with subrates after calling
model_stepN in the subrate loop.

Comments in rt_OneStep indicate the place to add your code.

In multirate rt_OneStep, you can improve performance by unrolling for and while loops.

In addition, you may choose to modify the overrun behavior to continue execution after error
recovery is complete.
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Also observe the following cautionary guidelines:

• You should not modify the way in which the counters, event flags, or other timing data structures
are set in rt_OneStep, or in functions called from rt_OneStep. The rt_OneStep timing data
structures (including rtModel) and logic are critical to the operation of the generated program.

• If you have customized the main program module to read model outputs after each base-rate
model step, be aware that selecting model configuration parameters Support: continuous time
and Single output/update function together can cause output values read from main for a
continuous output port to differ slightly from the corresponding output values in the model's
logged data. This is because, while logged data is a snapshot of output at major time steps, output
read from main after the base-rate model step potentially reflects intervening minor time steps. To
eliminate the discrepancy, either separate the generated output and update functions (clear the
Single output/update function parameter) or place a Zero-Order Hold block before the
continuous output port.

• It is possible to observe a mismatch between results from simulation and logged MAT file results
from generated code if you do not set model inputs before each time you call the model step
function. In the generated example main program, the following comments show the locations for
setting the inputs and stepping the model with your code:

/* Set model inputs here */
/* Step the model */

If your model applies signal reuse and you are using MatFileLogging for comparing results from
simulation against generated code, modify rt_OneStep to write model inputs in every time step
as directed by these comments. Alternatively, you could “Choose a SIL or PIL Approach” on page
80-11 for verification.

Static Main Program Module
• “Overview” on page 66-8
• “Rate Grouping and the Static Main Program” on page 66-9
• “Modify the Static Main Program” on page 66-10
• “Modify Static Main to Allocate and Access Model Instance Data” on page 66-11

Overview

In most cases, the easiest strategy for deploying generated code is to use the Generate an example
main program option to generate the ert_main.c or .cpp module (see “Generate a Standalone
Program” on page 66-2).

However, if you turn the Generate an example main program option off, you can use a static main
module as an example or template for developing your embedded applications. Static main modules
provided by MathWorks include:

• matlabroot/rtw/c/src/common/rt_main.c — Supports Nonreusable function code
interface packaging.

• matlabroot/rtw/c/src/common/rt_malloc_main.c — Supports Reusable function code
interface packaging. You must select model configuration parameter Use dynamic memory
allocation for model initialization and set parameter Pass root-level I/O as to Part of
model data structure.

• matlabroot/rtw/c/src/common/rt_cppclass_main.cpp — Supports C++ class code
interface packaging.
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The static main module is not part of the generated code; it is provided as a basis for your custom
modifications, and for use in simulation. If your existing applications depend upon a static
ert_main.c (developed in releases before R2012b), rt_main.c, rt_malloc_main.c, or
rt_cppclass_main.cpp, you may need to continue using a static main program module.

When developing applications using a static main module, you should copy the module to your
working folder and rename it before making modifications. For example, you could rename
rt_main.c to model_rt_main.c. Also, you must modify the template makefile or toolchain settings
such that the build process creates a corresponding object file, such as model_rt_main.obj (on
UNIX, model_rt_main.o), in the build folder.

The static main module contains

• rt_OneStep, a timer interrupt service routine (ISR). rt_OneStep calls model_step to execute
processing for one clock period of the model.

• A skeletal main function. As provided, main is useful in simulation only. You must modify main for
real-time interrupt-driven execution.

For single-rate models, the operation of rt_OneStep and the main function are essentially the same
in the static main module as they are in the automatically generated version described in “Deploy
Generated Standalone Executable Programs To Target Hardware” on page 66-2. For multirate,
multitasking models, however, the static and generated code are slightly different. The next section
describes this case.

Rate Grouping and the Static Main Program

Targets based on the ERT target sometimes use a static main module and disallow use of the
Generate an example main program option. This is done because target-specific modifications
have been added to the static main module, and these modifications would not be preserved if the
main program were regenerated.

Your static main module may or may not use rate grouping compatible model_stepN functions. If
your main module is based on the static rt_main.c, rt_malloc_main.c, or
rt_cppclass_main.cpp module, it does not use rate-specific model_stepN function calls. It uses
the old-style model_step function, passing in a task identifier:

void model_step(int_T tid);

By default, when the Generate an example main program option is off, the ERT target generates a
model_step “wrapper” for multirate, multitasking models. The purpose of the wrapper is to
interface the rate-specific model_stepN functions to the old-style call. The wrapper code dispatches
to the model_stepN call with a switch statement, as in the following example:

void mymodel_step(int_T tid) /* Sample time:  */
{

  switch(tid) {
   case 0 :
    mymodel_step0();
    break;
   case 1 :
    mymodel_step1();
    break;
   case 2 :
    mymodel_step2();
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    break;
   default :
    break;
  }
}

The following pseudocode shows how rt_OneStep calls model_step from the static main program
in a multirate, multitasking model.

rt_OneStep()
{
  Check for base-rate interrupt overflow
  Enable "rt_OneStep" interrupt
  Determine which rates need to run this time step

  ModelStep(tid=0)     --base-rate time step

  For N=1:NumTasks-1  -- iterate over sub-rate tasks
    Check for sub-rate interrupt overflow
    If (sub-rate task N is scheduled)
      ModelStep(tid=N)    --sub-rate time step
    EndIf
  EndFor
}

You can use the TLC variable RateBasedStepFcn to specify that only the rate-based step functions
are generated, without the wrapper function. If your target calls the rate grouping compatible
model_stepN function directly, set RateBasedStepFcn to 1. In this case, the wrapper function is
not generated.

You should set RateBasedStepFcn prior to the %include "codegenentry.tlc" statement in
your system target file. Alternatively, you can set RateBasedStepFcn in your
target_settings.tlc file.

Modify the Static Main Program

As with the generated ert_main.c or .cpp, you should make a few modifications to the main loop
and rt_OneStep. See “Guidelines for Modifying the Main Program” on page 66-3 and “Guidelines for
Modifying rt_OneStep” on page 66-7.

Also, you should replace the rt_OneStep call in the main loop with a background task call or null
statement.

Other modifications you may need to make are

• If applicable, follow comments in the code regarding where to add code for reading/writing model
I/O and saving/restoring FPU context.

Note If you modify rt_main.c, rt_malloc_main.c, or rt_cppclass_main.cpp to read a
value from a continuous output port after each base-rate model step, see the relevant cautionary
guideline in “Guidelines for Modifying rt_OneStep” on page 66-7.

• When the Generate an example main program option is off, rtmodel.h is generated to
provide an interface between the main module and generated model code. If you create your own
static main program module, you would normally include rtmodel.h.
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Alternatively, you can suppress generation of rtmodel.h, and include model.h directly in your
main module. To suppress generation of rtmodel.h, use the following statement in your system
target file:

%assign AutoBuildProcedure = 0

• If you have cleared the Terminate function required option, remove or comment out the
following in your production version of rt_main.c, rt_malloc_main.c, or
rt_cppclass_main.cpp:

• The #if TERMFCN... compile-time error check
• The call to MODEL_TERMINATE

• For rt_main.c (not applicable to rt_cppclass_main.cpp): If you do not want to combine
output and update functions, clear model configuration parameter Single output/update
function and make the following changes in your production version of rt_main.c:

• Replace calls to MODEL_STEP with calls to MODEL_OUTPUT and MODEL_UPDATE.
• Remove the #if ONESTEPFCN... error check.

• The static rt_main.c module does not support Reusable function code interface packaging.
The following error check raises a compile-time error if Reusable function code interface
packaging is used illegally.

#if MULTI_INSTANCE_CODE==1

Modify Static Main to Allocate and Access Model Instance Data

If you are using a static main program module, and your model is configured for Reusable
function code interface packaging, but the model configuration parameter Use dynamic memory
allocation for model initialization is cleared, model instance data must be allocated statically or
dynamically by the calling main code. Pointers to the individual model data structures (such as Block
IO, DWork, and Parameters) must be set up in the top-level real-time model data structure.

To support main modifications, the build process generates a subset of the following real-time model
(RTM) macros, based on the data requirements of your model, into model.h.

RTM Macro Syntax Description
rtmGetBlockIO(rtm) Get the block I/O data structure
rtmSetBlockIO(rtm,val) Set the block I/O data structure
rtmGetContStates(rtm) Get the continuous states data structure
rtmSetContStates(rtm,val) Set the continuous states data structure
rtmGetDefaultParam(rtm) Get the default parameters data structure
rtmSetDefaultParam(rtm,val) Set the default parameters data structure
rtmGetPrevZCSigState(rtm) Get the previous zero-crossing signal state data structure
rtmSetPrevZCSigState(rtm,val) Set the previous zero-crossing signal state data structure
rtmGetRootDWork(rtm) Get the DWork data structure
rtmSetRootDWork(rtm,val) Set the DWork data structure
rtmGetU(rtm) Get the root inputs data structure (when root inputs are

passed as part of the model data structure)
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RTM Macro Syntax Description
rtmSetU(rtm,val) Set the root inputs data structure (when root inputs are

passed as part of the model data structure)
rtmGetY(rtm) Get the root outputs data structure (when root outputs are

passed as part of the model data structure)
rtmSetY(rtm,val) Set the root outputs data structure (when root outputs are

passed as part of the model data structure)

Use these macros in your static main program to access individual model data structures within the
RTM data structure. For example, suppose that the example model rtwdemo_reusable is configured
with Reusable function code interface packaging, Use dynamic memory allocation for model
initialization cleared, Pass root-level I/O as set to Individual arguments, and Optimization
pane option Remove root level I/O zero initialization cleared. Building the model generates the
following model data structures and model entry-points into rtwdemo_reusable.h:
/* Block states (auto storage) for system '<Root>' */
typedef struct {
  real_T Delay_DSTATE;                 /* '<Root>/Delay' */
} D_Work;

/* Parameters (auto storage) */
struct Parameters_ {
  real_T k1;                           /* Variable: k1
                                        * Referenced by: '<Root>/Gain'
                                        */
};

/* Model entry point functions */
extern void rtwdemo_reusable_initialize(RT_MODEL *const rtM, real_T *rtU_In1,
  real_T *rtU_In2, real_T *rtY_Out1);
extern void rtwdemo_reusable_step(RT_MODEL *const rtM, real_T rtU_In1, real_T
  rtU_In2, real_T *rtY_Out1);

Additionally, if model configuration parameter Generate an example main program is not selected
for the model, rtwdemo_reusable.h contains definitions for the RTM macros
rtmGetDefaultParam, rtmsetDefaultParam, rtmGetRootDWork, and rtmSetRootDWork.

Also, for reference, the generated rtmodel.h file contains an example parameter definition with
initial values (non-executing code):
#if 0

/* Example parameter data definition with initial values */
static Parameters rtP = {
  2.0                                  /* Variable: k1
                                        * Referenced by: '<Root>/Gain'
                                        */
};                                     /* Modifiable parameters */

#endif

In the definitions section of your static main file, you could use the following code to statically
allocate the real-time model data structures and arguments for the rtwdemo_reusable model:
static RT_MODEL rtM_;
static RT_MODEL *const rtM = &rtM_;    /* Real-time model */
static Parameters rtP = {
  2.0                                  /* Variable: k1
                                        * Referenced by: '<Root>/Gain'
                                        */
};                                     /* Modifiable parameters */

static D_Work rtDWork;                 /* Observable states */
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/* '<Root>/In1' */
static real_T rtU_In1;

/* '<Root>/In2' */
static real_T rtU_In2;

/* '<Root>/Out1' */
static real_T rtY_Out1;

In the body of your main function, you could use the following RTM macro calls to set up the model
parameters and DWork data in the real-time model data structure:
int_T main(int_T argc, const char *argv[])
{
...
/* Pack model data into RTM */

rtmSetDefaultParam(rtM, &rtP);
rtmSetRootDWork(rtM, &rtDWork);

/* Initialize model */
rtwdemo_reusable_initialize(rtM, &rtU_In1, &rtU_In2, &rtY_Out1);
...
}

Follow a similar approach to set up multiple instances of model data, where the real-time model data
structure for each instance has its own data. In particular, the parameter structure (rtP) should be
initialized, for each instance, to the desired values, either statically as part of the rtP data definition
or at run time.

Rate Grouping Compliance and Compatibility Issues
• “Main Program Compatibility” on page 66-13
• “Make Your S-Functions Rate Grouping Compliant” on page 66-13

Main Program Compatibility

When the Generate an example main program option is off, code generation produces slightly
different rate grouping code, for compatibility with the older static ert_main.c module. See “Rate
Grouping and the Static Main Program” on page 66-9 for details.

Make Your S-Functions Rate Grouping Compliant

Built-in Simulink blocks, as well as DSP System Toolbox blocks, are compliant with the requirements
for generating rate grouping code. However, user-written multirate inlined S-functions may not be
rate grouping compliant. Noncompliant blocks generate less efficient code, but are otherwise
compatible with rate grouping. To take full advantage of the efficiency of rate grouping, your
multirate inlined S-functions must be upgraded to be fully rate grouping compliant. You should
upgrade your TLC S-function implementations, as described in this section.

Use of noncompliant multirate blocks to generate rate-grouping code generates dead code. This can
cause two problems:

• Reduced code efficiency.
• Warning messages issued at compile time. Such warnings are caused when dead code references

temporary variables before initialization. Since the dead code does not run, this problem does not
affect the run-time behavior of the generated code.
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To make your S-functions rate grouping compliant, you can use the following TLC functions to
generate ModelOutputs and ModelUpdate code, respectively:

OutputsForTID(block, system, tid)
UpdateForTID(block, system, tid)

The code listings below illustrate generation of output computations without rate grouping (Listing 1)
and with rate grouping (Listing 2). Note the following:

• The tid argument is a task identifier (0..NumTasks-1).
• Only code guarded by the tid passed in to OutputsForTID is generated. The if

(%<LibIsSFcnSampleHit(portName)>) test is not used in OutputsForTID.
• When generating rate grouping code, OutputsForTID and/or UpdateForTID is called during

code generation. When generating non-rate-grouping code, Outputs and/or Update is called.
• In rate grouping compliant code, the top-level Outputs and/or Update functions call

OutputsForTID and/or UpdateForTID functions for each rate (tid) involved in the block. The
code returned by OutputsForTID and/or UpdateForTID must be guarded by the corresponding
tid guard:

if (%<LibIsSFcnSampleHit(portName)>)

as in Listing 2.

Listing 1: Outputs Code Generation Without Rate Grouping
%% multirate_blk.tlc

%implements "multirate_blk" "C"

%% Function: mdlOutputs =====================================================
%% Abstract:
%%
%%  Compute the two outputs (input signal decimated by the
%%  specified parameter). The decimation is handled by sample times.
%%  The decimation is only performed if the block is enabled.
%%  Each port has a different rate.
%%
%%  Note, the usage of the enable should really be protected such that
%%  each task has its own enable state. In this example, the enable
%% occurs immediately which may or may not be the expected behavior.
%%
  %function Outputs(block, system) Output
  /* %<Type> Block: %<Name> */
  %assign enable = LibBlockInputSignal(0, "", "", 0)
  {
    int_T *enabled = &%<LibBlockIWork(0, "", "", 0)>;

    %if LibGetSFcnTIDType("InputPortIdx0") == "continuous"
      %% Only check the enable signal on a major time step.
      if (%<LibIsMajorTimeStep()> && ...
                           %<LibIsSFcnSampleHit("InputPortIdx0")>) {
        *enabled = (%<enable> > 0.0);
      }
    %else
      if (%<LibIsSFcnSampleHit("InputPortIdx0")>) {
        *enabled = (%<enable> > 0.0);
      }
    %endif

    if (*enabled) {
      %assign signal = LibBlockInputSignal(1, "", "", 0)
      if (%<LibIsSFcnSampleHit("OutputPortIdx0")>) {
        %assign y = LibBlockOutputSignal(0, "", "", 0)   
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        %<y> = %<signal>;
      }
      if (%<LibIsSFcnSampleHit("OutputPortIdx1")>) {
        %assign y = LibBlockOutputSignal(1, "", "", 0)
        %<y> = %<signal>;
      }
    }
  }

  %endfunction
%% [EOF] sfun_multirate.tlc

Listing 2: Outputs Code Generation With Rate Grouping

%% example_multirateblk.tlc

%implements "example_multirateblk" "C"

  %% Function: mdlOutputs =====================================================
  %% Abstract:
  %%
  %% Compute the two outputs (the input signal decimated by the
  %% specified parameter). The decimation is handled by sample times.
  %% The decimation is only performed if the block is enabled.  
  %% All ports have different sample rate.
  %%
  %% Note: the usage of the enable should really be protected such that
  %% each task has its own enable state. In this example, the enable
  %% occurs immediately which may or may not be the expected behavior.
  %%
  %function Outputs(block, system) Output

  %assign portIdxName = ["InputPortIdx0","OutputPortIdx0","OutputPortIdx1"]
  %assign portTID     = [%<LibGetGlobalTIDFromLocalSFcnTID("InputPortIdx0")>, ...
                        %<LibGetGlobalTIDFromLocalSFcnTID("OutputPortIdx0")>, ...
                        %<LibGetGlobalTIDFromLocalSFcnTID("OutputPortIdx1")>]
  %foreach i = 3
    %assign portName = portIdxName[i]
    %assign tid      = portTID[i]
    if (%<LibIsSFcnSampleHit(portName)>) {
                       %<OutputsForTID(block,system,tid)>
    }
  %endforeach

  %endfunction

  %function OutputsForTID(block, system, tid) Output
  /* %<Type> Block: %<Name> */
  %assign enable = LibBlockInputSignal(0, "", "", 0)  
  %assign enabled = LibBlockIWork(0, "", "", 0)  
  %assign signal = LibBlockInputSignal(1, "", "", 0)

  %switch(tid)
    %case LibGetGlobalTIDFromLocalSFcnTID("InputPortIdx0") 
                         %if LibGetSFcnTIDType("InputPortIdx0") == "continuous"
                           %% Only check the enable signal on a major time step.
                           if (%<LibIsMajorTimeStep()>) {  
                             %<enabled> = (%<enable> > 0.0);
                           }
                         %else
                           %<enabled> = (%<enable> > 0.0);
                         %endif
                         %break
    %case LibGetGlobalTIDFromLocalSFcnTID("OutputPortIdx0") 
                         if (%<enabled>) {
                           %assign y = LibBlockOutputSignal(0, "", "", 0)
                           %<y> = %<signal>;
                         }
                         %break
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    %case LibGetGlobalTIDFromLocalSFcnTID("OutputPortIdx1") 
                         if (%<enabled>) {
                           %assign y = LibBlockOutputSignal(1, "", "", 0)
                           %<y> = %<signal>;
                         }
                         %break
    %default 
                         %% error it out
  %endswitch

  %endfunction

%% [EOF] sfun_multirate.tlc

Generate Code That Dereferences Data from a Literal Memory Address
This example shows how to generate code that reads the value of a signal by dereferencing a memory
address that you specify. With this technique, you can generate a control algorithm that interacts with
memory that your hardware populates (for example, memory that stores the output of an analog-to-
digital converter in a microcontroller).

In this example, you generate an algorithm that acquires input data from a 16-bit block of memory at
address 0x8675309. Assume that a hardware device asynchronously populates only the lower 10 bits
of the address. The algorithm must treat the address as read-only (const), volatile (volatile) data,
and ignore the upper 6 bits of the address.

The generated code can access the data by defining a macro that dereferences 0x8675309 and
masks the unnecessary bits:

#define A2D_INPUT ((*(volatile const uint16_T *)0x8675309)&0x03FF)

To configure a model to generate code that defines and uses this macro:

1 Create the example model.
2 Create package to contain definitions of data class and storage class.
3 Use Custom Storage Class Designer to create a storage class.
4 Define a class to store property settings for the storage class.
5 Write Target Language Compiler (TLC) code that emits the correct C code for the storage class.
6 Define a class for the inport data.
7 Load the package into the Embedded Coder Dictionary.
8 Configure the model root-level inport to use the storage class.
9 Generate and inspect the code.

For an example that shows how to use the Custom Storage Class Designer without writing TLC code,
see “Create and Apply a Storage Class” on page 38-15.

As an alternative to writing TLC code, you can use memory sections to generate code that includes
pragmas. Depending on your build toolchain, you can use pragmas to specify a literal memory
address for storing a global variable. For more information about memory sections, see “Control Data
and Function Placement in Memory by Inserting Pragmas” on page 43-2.

Derivation of Macro Syntax

In this example, you configure the generated code to define and use the dereferencing macro. To
determine the correct syntax for the macro, start by recording the target address.
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0x8675309

Cast the address as a pointer to a 16-bit integer. Use the Simulink Coder data type name uint16_T.

(uint16_T *)0x8675309

Add the storage type qualifier const because the generated code must not write to the address. Add
volatile because the hardware can populate the address at an arbitrary time.

(volatile const uint16_T *)0x8675309

Dereference the address.

*(volatile const uint16_T *)0x8675309

After the dereference operation, apply a mask to retain only the 10 bits that the hardware populates.
Use explicit parentheses to control the order of operations.

(*(volatile const uint16_T *)0x8675309)&0x03FF

As a safe coding practice, wrap the entire construct in another layer of parentheses.

((*(volatile const uint16_T *)0x8675309)&0x03FF)

Create Example Model

Create the example model ex_memmap_simple.

For the Inport block, set the output data type to uint16. Name the signal as A2D_INPUT. The
Inport block and the signal line represent the data that the hardware populates.

For the Gain block, set the output data type to double.

Create Package to Contain Definitions of Data Class and Storage Class

In your current folder, create a folder named +MemoryMap. The folder defines a package named
MemoryMap.

To make the package available for use outside of your current folder, you can add the folder
containing the +MemoryMap folder to the MATLAB path.

Create Storage Class

To generate code that defines and reads A2D_INPUT as a macro, you must create a storage class that
you can apply to the model root-level inport. Later, you write TLC code that complements the storage
class.

Open the Custom Storage Class designer in advanced mode. To design a storage class that operates
through custom TLC code, you must use the advanced mode.

cscdesigner('MemoryMap','-advanced');
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In the Custom Storage Class Designer, click New. A new custom storage class, NewCSC_1, appears in
the list of storage class definitions.

Rename the storage class to MemoryMappedAddress.

For MemoryMappedAddress, on the General tab, set:

• Type to Other. The storage class can operate through custom TLC code that you write later.
• Data scope to Exported. For data items that use this custom storage class, Simulink Coder

generates the definition (for example, the #define statement that defines a macro).
• Data initialization to None. Simulink Coder does not generate code that initializes the data item.

Use this setting because this custom storage class represents read-only data. You do not select
Macro because the Custom Storage Class Designer does not allow you to use Macro for signal
data.

• Definition file to Specify (leave the text box empty). For data items that consume memory in
the generated code, Definition file specifies the .c source file that allocates the memory. This
storage class yields a macro, which does not require memory. Typically, header files (.h), not .c
files, define macros. Setting Definition file to Specify instead of Instance specific prevents
users of the storage class from unnecessarily specifying a definition file.

• Header file to Instance specific. To control the file placement of the macro definition, the
user of the storage class must specify a header file for each data item that uses this storage class.

• Owner to Specify (leave the text box empty). Owner applies only to data items that consume
memory.

After you finish selecting the settings, click Apply and Save.

Now, when you apply the storage class to a data item, such as inport In1, you can specify a header
file to contain the generated macro definition. You cannot yet specify a memory address for the data
item. To enable specification of a memory address, create a custom attributes class that you can
associate with the MemoryMappedAddress storage class.

Define Class to Store Property Settings for Storage Class

Define a MATLAB class to store additional information for data items that use the storage class. In
this case, the additional information is the memory address.

In the MemoryMap package (the +MemoryMap folder), create a folder named @MemoryMapAttribs.

In the @MemoryMapAttribs folder, create a file named MemoryMapAttribs. The file defines a class
that derives from the built-in class Simulink.CustomStorageClassAttributes.

classdef MemoryMapAttribs < Simulink.CustomStorageClassAttributes
    properties( PropertyType = 'char' )
        MemoryAddress = '';
    end
end

Later, you associate this MATLAB class with the MemoryMappedAddress storage class. Then, when
you apply the storage class to a data item, you can specify a memory address.
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Write TLC Code That Emits Correct C Code

Write TLC code that uses the attributes of the storage class, such as HeaderFile and
MemoryAddress, to generate correct C code for each data item.

In the +MemoryMap folder, create a folder named tlc.

Navigate to the new folder.

Inspect the built-in template TLC file, TEMPLATE_v1.tlc.

edit(fullfile(matlabroot,...
    'toolbox','rtw','targets','ecoder','csc_templates','TEMPLATE_v1.tlc'))

Save a copy of TEMPLATE_v1.tlc in the tlc folder. Rename the copy memory_map_csc.tlc.

In memory_map_csc.tlc, find the portion that controls the generation of C-code data declarations.

    %case "declare"

      %% LibDefaultCustomStorageDeclare is the default declare function to
      %% declares a global variable whose identifier is the name of the data.
      %return "extern %<LibDefaultCustomStorageDeclare(record)>"
      %%break

    %% ==========================================================================

The declare case (%case) constructs a return value (%return), which the code generator emits into
the header file that you specify for each data item. To control the C code that declares each data item,
adjust the return value in the declare case.

Replace the existing %case content with this new code, which specifies a different return value:

%case "declare"

        %% In TLC code, a 'record' is a data item (for example, a signal line).
        %% 'LibGetRecordIdentifier' returns the name of the data item.
        %assign id = LibGetRecordIdentifier(record)

        %assign dt = LibGetRecordCompositeDataTypeName(record)

        %% The 'CoderInfo' property of a data item stores a
        %% 'Simulink.CoderInfo' object, which stores code generation settings
        %% such as the storage class or custom storage class that you specify
        %% for the item.
        %assign ci = record.Object.ObjectProperties.CoderInfo
        %% The 'ci' variable now stores the 'Simulink.CoderInfo' object.
        
        %% By default, the 'CustomAttributes' property of a 'Simulink.CoderInfo'
        %% object stores a 'Simulink.CustomStorageClassAttributes' object.
        %% This nested object stores specialized code generation settings
        %% such as the header file and definition file that you specify for
        %% the data item.
        %%
        %% The 'MemoryMap' package derives a new class, 
        %% 'MemoryMapAttribs', from 'Simulink.CustomStorageClassAttributes'.
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        %% The new class adds a property named 'MemoryAddress'.
        %% This TLC code determines the memory address of the data item by
        %% acquiring the value of the 'MemoryAddress' property.
        %assign ca = ci.Object.ObjectProperties.CustomAttributes
        %assign address = ca.Object.ObjectProperties.MemoryAddress

        %assign width = LibGetDataWidth(record)

        %% This TLC code constructs the full macro, with correct C syntax,
        %% based on the values of TLC variables such as 'address' and 'dt'.
        %% This TLC code also asserts that the data item must be a scalar.
        %if width == 1
                %assign macro = ...
                    "#define %<id> ((*(volatile const %<dt>*)%<address>) & 0x03FF)"
        %else
                %error( "Non scalars are not supported yet." )
        %endif

        %return "%<macro>"
      %%break

    %% ==========================================================================

The new TLC code uses built-in, documented TLC functions, such as LibGetRecordIdentifier,
and other TLC commands and operations to access information about the data item. Temporary
variables such as dt and address store that information. The TLC code constructs the full macro,
with the correct C syntax, by expanding the variables, and stores the macro in the variable macro.

In the same file, find the portion that controls the generation of data definitions.

    %case "define"

      %% LibDefaultCustomStorageDefine is the default define function to define
      %% a global variable whose identifier is the name of the data.  If the
      %% data is a parameter, the definition is also statically initialized to
      %% its nominal value (as set in MATLAB).
      %return "%<LibDefaultCustomStorageDefine(record)>"
      %%break

    %% ==========================================================================

The define case derives a return value that the code generator emits into a .c file, which defines
data items that consume memory.

Replace the existing %case content with this new content:

    %case "define"
      %return ""
      %%break

    %% ==========================================================================

MemoryMappedAddress yields a macro in the generated code, so you use the declare case instead
of the define case to construct and emit the macro. To prevent the define case from emitting a
duplicate macro definition, the new TLC code returns an empty string.
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Find the portion that controls the generation of code that initializes data.

    %case "initialize"

      %% LibDefaultCustomStorageInitialize is the default initialization
      %% function that initializes a scalar element of a global variable to 0. 
      %return LibDefaultCustomStorageInitialize(record, idx, reim)
      %%break

    %% ==========================================================================

The initialize case generates code that initializes data items (for example, in the
model_initialize function).

Replace the existing %case content with this new content:

    %case "initialize"
      %return ""
      %%break

    %% ==========================================================================

MemoryMappedAddress yields a macro, so the generated code must not attempt to initialize the
value of the macro. The new TLC code returns an empty string.

Complete the Definition of the Storage Class

Your new MATLAB class, MemoryMapAttribs, can enable users of your storage class,
MemoryMappedAddress, to specify a memory address for each data item. To allow this specification,
associate MemoryMapAttribs with MemoryMappedAddress. To generate correct C code based on
the information that you specify for each data item, associate the customized TLC file,
memory_map_csc.tlc, with MemoryMappedAddress.

Navigate to the folder that contains the +MemoryMap folder.

Open the Custom Storage Class Designer again.

cscdesigner('MemoryMap','-advanced');

For MemoryMappedAddress, on the Other Attributes tab, set:

• TLC file name to memory_map_csc.tlc.
• CSC attributes class to MemoryMap.MemoryMapAttribs.

Click Apply and Save.

Define Signal Data Class

To apply the storage class to a data element in a model, in the MemoryMap package, you must create
a MATLAB class that derives from Simulink.Signal. When you configure the signal in the model,
you select this new data class instead of the default class, Simulink.Signal.

In the MemoryMap package, create a folder named @Signal.

In the @Signal folder, create a file named Signal.m.
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classdef Signal < Simulink.Signal
    methods
        function setupCoderInfo( this )
            useLocalCustomStorageClasses( this, 'MemoryMap' );
            return;
        end
    end
end

The file defines a class named MemoryMap.Signal. The class definition overrides the
setupCoderInfo method, which the Simulink.Signal class already implements. The new
implementation specifies that objects of the MemoryMap.Signal class use custom storage classes
from the MemoryMap package (instead of storage classes from the Simulink package). When you
configure a signal in a model by selecting the MemoryMap.Signal class, you can select the new
custom storage class, MemoryMappedAddress.

Load Package into Embedded Coder Dictionary

Navigate to the folder that contains the example model and open the model.

Open the Embedded Coder app.

Open the Embedded Coder Dictionary. On the C Code tab, select Code Interface > Embedded
Coder Dictionary.

In the Embedded Coder Dictionary, click Manage Packages.

In the Manage Package dialog box, click Refresh. When the refresh is complete, select the package
MemoryMap. Click Load.

Close the Embedded Coder Dictionary.

Configure Root-Level Inport to Use Storage Class

In the Embedded Coder app, use the Code Mappings editor and Property Inspector to configure
Inport In1 to use the storage class that you defined.

Open the Code Mappings editor. On the C Code tab, select Code Interface > Individual Element
Code Mappings.

In the Code Mappings Editor, on the Inports tab, select inport In1. Set the storage class for In1 to
MemoryMappedAddress.

In the Property Inspector, under Code, set the HeaderFile property to
memory_mapped_addresses.h and the MemoryAddress property to 0x8675309.

Save the model.

Generate and Inspect Code

Generate code from the model.

### Starting build procedure for: ex_memmap_simple
### Successful completion of build procedure for: ex_memmap_simple
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Build Summary

Top model targets built:

Model             Action                       Rebuild Reason                                    
=================================================================================================
ex_memmap_simple  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.389s

Inspect the generated header file memory_mapped_addresses.h. The file defines the macro
A2D_INPUT, which corresponds to the signal line in the model.

/* Declaration of data with custom storage class MemoryMappedAddress */
#define A2D_INPUT                      ((*(volatile const uint16_T*)0x8675309) & 0x03FF)

Inspect the generated file ex_memmap_simple.c. The generated algorithmic code (which
corresponds to the Gain block) calculates the model output, rtY.Out1, by operating on A2D_INPUT.

/* Model step function */
void step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/In1'
   */
  rtY.Out1 = 42.0 * (real_T)A2D_INPUT;
}

See Also

More About
• “Design Models for Generated Embedded Code Deployment” on page 1-2
• “How Generated Code Exchanges Data with an Environment” on page 34-35
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Generate Main Program for Deployment to Bare Board Target
This example shows how to configure a model such that the code generator produces an example
main program that you can customize for deployment on bare-board target hardware (does not have
an operating system). When you select the model configuration parameter Generate an example
main program, the code generator produces the example file ert_main.c or ert_main.cpp. This
file includes:

• main() function for the generated program
• Task scheduling code that determines how and when block computations execute on each time

step of the model

Operation of the main program and the scheduling algorithm depend primarily on:

• Whether the model is a single-rate or multirate model
• Whether the model solver mode is set to single-tasking or multitasking

For more information, see “Deploy Generated Standalone Executable Programs To Target Hardware”
on page 66-2.

Alternatively, you can configure a model to generate an example main program for deployment on
target hardware that is running the VxWorks&reg operating system or threaded code that runs on
your host operating system. The example file ert_main.c that the code generator produces, shows
how to deploy the generated example code.

You can customize a generated main program by using a custom file processing (CFP) template.
Consider using a template file to:

• Assemble generated code in buffers
• Call an API to obtain buffered code into specific sections of generated source and header files

For more information, see “File customization template”.

Open Example Model

Open the example model rtwdemo_examplemain.

open_system('rtwdemo_examplemain');
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Configure Model

1. Open the Embedded Coder app.

2. Select model configuration parameter Generate an example main program. When you select
this parameter, you enable parameter Target operating system.

3. Set parameter Target operating system to BareBoardExample, VxWorksExample, or
NativeThreadsExample. For more information, see “Target operating system”.

4. Consider whether you want to specify a custom file processing template. To configure a template,
specify the file name and extension for your template TLC file as a string for model configuration
parameter File customization template.

Generate Code

Generate and inspect the code.

Add Hand-Coded Customizations

Augment the generated code with hand code as needed.
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Deploy Generated Component Software to Application Target
Platforms

The code generator supports integration of generated code with operating systems and processors.
For details, see “Embedded Coder Supported Hardware”.

Interface to an Example Real-Time Multitasking System
This example shows how to simulate and generate code for asynchronous events on a real-time
multitasking system.

The operating system integration techniques that the example demonstrates use one or more blocks
in the vxlib1 library. These blocks provide starting point examples to help you develop custom
blocks for your target environment.

Example Model

Open the rtwdemo_vxworks model.

model = 'rtwdemo_vxworks';
open_system(model);
%
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Model Description

The example model contains two asynchronously executed subsystems, Count and Algorithm.
Count executes at interrupt level. Algorithm executes in an asynchronous task. The generated code
for these blocks is tailored for the VxWorks® operating system. However, you can modify the Async
Interrupt and Task Sync blocks to generate code for your run-time environment whether you are
using an operating system or not.

Related Information

• Async Interrupt
• Task Sync
• “Generate Interrupt Service Routines”
• “Timers in Asynchronous Tasks”
• “Create a Customized Asynchronous Library”
• “Import Asynchronous Event Data for Simulation”
• “Load Data to Root-Level Input Ports”
• “Asynchronous Events”
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• “Rate Transitions and Asynchronous Blocks”
• “Asynchronous Support Limitations”

See Also

More About
• “Design Models for Generated Embedded Code Deployment” on page 1-2
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Code Replacement Customization for
Simulink Models in Embedded Coder

• “What Is Code Replacement Customization?” on page 67-3
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Quick Start Code Replacement Library Development - Simulink®” on page 67-21
• “Semaphore and Mutex Function Replacement” on page 67-30
• “Identify Code Replacement Library Requirements” on page 67-35
• “Define Code Replacement Library Optimizations” on page 67-36
• “Register Code Replacement Library” on page 67-51
• “Verify Code Replacement Library” on page 67-55
• “Deploy Code Replacement Library” on page 67-57
• “Troubleshoot Code Replacement Library Registration” on page 67-58
• “Troubleshoot Code Replacement Misses” on page 67-59
• “Math Function Code Replacement” on page 67-64
• “Memory Function Code Replacement” on page 67-71
• “Nonfinite Function Code Replacement” on page 67-76
• “Algorithm-Based Code Replacement” on page 67-81
• “Lookup Table Function Code Replacement” on page 67-87
• “Data Alignment for Code Replacement” on page 67-97
• “Replace MATLAB Functions with Custom Code by Using the coder.replace Function”

on page 67-104
• “Replace coder.ceval Calls to External Functions” on page 67-110
• “Reserved Identifiers and Code Replacement” on page 67-117
• “Customize Match and Replacement Process” on page 67-118
• “Scalar Operator Code Replacement” on page 67-129
• “Addition and Subtraction Operator Code Replacement” on page 67-134
• “Matrix Multiplication Operation to MathWorks BLAS Code Replacement” on page 67-141
• “Matrix Multiplication Operation to ANSI/ISO C BLAS Code Replacement” on page 67-151
• “Small Matrix Operation to Processor Code Replacement” on page 67-158
• “Remap Operator Output to Function Input” on page 67-166
• “Fixed-Point Operator Code Replacement” on page 67-169
• “Binary-Point-Only Scaling Code Replacement” on page 67-175
• “Slope Bias Scaling Code Replacement” on page 67-180
• “Net Slope Scaling Code Replacement” on page 67-186
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• “Equal Slope and Zero Net Bias Code Replacement” on page 67-193
• “Data Type Conversions (Casts) and Operator Code Replacement” on page 67-199
• “Shift Left Operations and Code Replacement” on page 67-205
• “Optimize Generated Code by Using Multiple Code Replacement Libraries” on page 67-210
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What Is Code Replacement Customization?
Customize how and when the code generator replaces C/C++ code that it generates by default for
functions and operators by developing a custom code replacement library. You can develop libraries
interactively with the Code Replacement Tool or programmatically.

• Develop libraries tailored to specific application requirements
• Add identifiers to the list of reserved keywords the code generator considers during code

replacement
• Customize the code generator’s match and replacement process for functions

To get started, “Quick Start Code Replacement Library Development - Simulink®” on page 67-21.

Code Replacement Match and Replacement Process
When the code generator encounters a call site for a function or operator, it:

1 Creates and partially populates a code replacement entry object with the function or operator
name or key and conceptual arguments.

2 Uses the entry object to query the configured code replacement library for a conceptual
representation match. The code generator searches the tables in a code replacement library for a
match in the order that the tables appear in the library. When searching for a match, the code
generator takes into account:

• Conceptual name or key
• Arguments, including quantity, type, type qualifiers, and complexity
• Algorithm (computation method)
• Fixed-point saturation and rounding modes
• Priority

3 When a match exists, the code generator returns a code replacement object, fully populated with
the conceptual representation, implementation representation, and priority. If the code generator
finds multiple matches within a table, the entry priority determines the match. The priority can
range from 0 to 100. The highest priority is 0. The code generator uses a higher-priority entry
over a similar entry with a lower priority.

4 Uses the C or C++ replacement function prototype in the code replacement object to generate
code.

Code Replacement Customization Limitations
• Code replacement verification — It is possible that code replacement behaves differently than you

expect. For example, data types that you observe in code generator input might not match what
the code generator uses as intermediate data types during an operation. Verify code replacements
by examining generated code. See “Verify Code Replacement Library” on page 67-55.

• Code replacement for matrices — Code replacement libraries do not support the replacement of
functions that have variable-size inputs.

• Tokens in file paths—You can include tokens in file paths when specifying build information for a
code replacement entry by using the programming interface only. The ability to include tokens is
not available from the Code Replacement Tool. See Specify build information in “Define Code
Replacement Library Optimizations” on page 67-36.
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• Addition and subtraction operation replacements—See “Addition and Subtraction Operator Code
Replacement” on page 67-134 for relevant limitations.

• Data alignment—

• Not supported for

• Arguments associated with a built-in storage class with DataScope set to Exported or the
imported built-in storage class GetSet

• Software-in-the-loop (SIL)
• Processor-in-the-loop (PIL)
• Model reference parameters
• Exported functions in Stateflow charts
• Replaced functions that are generated with C function prototype control or C++ class I/O

arguments step method and that use root-level I/O variables
• Replaced functions that are generated with the AUTOSAR system target file and that use

root-level I/O or AUTOSAR inter-runnable access functions
• If the following conditions exist, the code generator includes data alignment directives for root-

level I/O variables in the ert_main.c or ert_main.cpp file it produces:

• Compiler supports global variable alignment
• Generate an example main program (select Configuration Parameters > Generate an

example main program)
• Generate a reusable function interface for the model (set Configuration Parameters >

Code Generation > Interface > Code interface packaging to Reusable function)
• Function uses root-level I/O variables that are passed in as individual arguments (set
Configuration Parameters > Code Generation > Interface > Pass root-level I/O asto
Individual arguments)

• Replaced function uses a root-level I/O variable
• Replaced function imposes alignment requirements

• If you discard the generated example main program, align used root-level I/O variables
correctly.

• If you choose not to generate an example main program in this case, the code generator does
not replace the function.

• If a replacement imposes alignment requirements on the shared utility interface arguments,
the code generator does not honor data alignment. Under these conditions, replacement does
not occur. Replacement is allowed if the registered data alignment type specification supports
alignment of local variables, and the replacement involves only local variables.

• For Simulink.Bus:

• If user registered alignment specifications do not support structure field alignment,
aligning Simulink.Bus objects is not supported unless the Simulink.Bus is imported.

• When aligning a Simulink.Bus data object, the elements in the bus object are aligned on
the same boundary. The boundary is the lowest common multiple of the alignment
requirements for each individual bus element.

• When you specify alignment for functions that occur in a model reference hierarchy, and
multiple models in the hierarchy operate on the same function data, the bottommost model
dictates alignment for the rest of the hierarchy. If the alignment requirement for a function in a
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model higher in the hierarchy cannot be honored due to the alignment set by a model lower in
the hierarchy, the replacement in the higher model does not occur. In some cases, an error
message is generated. To work around this issue, if the shared data is represented by a bus or
signal object, manually set the alignment property on the shared data by setting the alignment
property of the Simulink.Bus or Simulink.Signal object.

• It is your responsibility to honor the Alignment property setting for storage classes that you
create.

See “Data Alignment for Code Replacement” on page 67-97.
• coder.replace function — See coder.replace for relevant limitations.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Quick Start Code Replacement Library Development - Simulink®” on page 67-21
• “What Is Code Replacement?” on page 54-2
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Code You Can Replace From Simulink Models
Code that the code generator replaces depends on the code replacement library (CRL) that you use.
By default, the code generator does not apply a code replacement library. Your choice of libraries is
dependent on product licensing and whether you have access to custom libraries.

For information on how to explore functions and operators that a code replacement library supports,
see “Choose a Code Replacement Library” on page 55-6 license and want to develop a custom code
replacement library, see Code Replacement Customization.

Math Functions – Simulink Support
When generating C/C++ code from a Simulink model, depending on code replacement libraries
available in your development environment, you can configure the code generator to replace
instances of the following math functions with application-specific implementations.

Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

abs1 Integer
Floating point
Fixed point

Scalar
Vector
Matrix

Real

acos Floating point Scalar Real
Complex input/complex output
Real input/complex output

acosd2 Floating point Scalar
Vector
Matrix

Real
Complex

acosh Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

acot2 Floating point Scalar
Vector
Matrix

Real
Complex

acotd2 Floating point Scalar
Vector
Matrix

Real
Complex

acoth2 Floating point Scalar
Vector
Matrix

Real
Complex

acsc2 Floating point Scalar
Vector
Matrix

Real
Complex

acscd2 Floating point Scalar
Vector
Matrix

Real
Complex
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

acsch2 Floating point Scalar
Vector
Matrix

Real
Complex

asec2 Floating point Scalar
Vector
Matrix

Real
Complex

asecd2 Floating point Scalar
Vector
Matrix

Real
Complex

asech2 Floating point Scalar
Vector
Matrix

Real
Complex

asin Floating point Scalar Real
Complex input/complex output
Real input/complex output

asind2 Floating point Scalar
Vector
Matrix

Real
Complex

asinh Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

atan Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

atan2 Floating point Scalar
Vector
Matrix

Real

atan2d2 Floating point Scalar
Vector
Matrix

Real

atand2 Floating point Scalar
Vector
Matrix

Real
Complex

atanh Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

ceil Floating-point
Scalar

Floating-point
Scalar

Floating-point
Scalar

cos3 Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

cosd2 Floating point Scalar
Vector
Matrix

Real
Complex
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

cosh Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

cot2 Floating point Scalar
Vector
Matrix

Real
Complex

cotd2 Floating point Scalar
Vector
Matrix

Real
Complex

coth2 Floating point Scalar
Vector
Matrix

Real
Complex

csc2 Floating point Scalar
Vector
Matrix

Real
Complex

cscd2 Floating point Scalar
Vector
Matrix

Real
Complex

csch2 Floating point Scalar
Vector
Matrix

Real
Complex

exactrSqrt Integer
Floating point

Scalar Real

exp Floating point Scalar
Vector
Matrix

Real

fix Floating point Scalar Real
floor Floating-point

Scalar
Floating-point
Scalar

Floating-point
Scalar

fmod4 Floating point Scalar Real
frexp Floating point Scalar Real
hypot Floating point Scalar

Vector
Matrix

Real

ldexp Floating point Scalar Real
ln Floating point Scalar Real
log Floating point Scalar

Vector
Matrix

Real

log10 Floating point Scalar
Vector
Matrix

Real
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

log22 Floating point Scalar
Vector
Matrix

Real
Complex

max Integer
Floating point
Fixed point

Scalar Real

min Integer
Floating point
Fixed point

Scalar Real

mod Integer
Floating point

Scalar
Vector
Matrix

Real

pow Floating point Scalar
Vector
Matrix

Real

rem Floating point Scalar
Vector
Matrix

Real

round Floating point Scalar Real
rSqrt Integer

Floating point
Scalar
Vector
Matrix

Real

saturate Integer
Floating point
Fixed point

Scalar
Vector
Matrix

Real

sec2 Floating point Scalar
Vector
Matrix

Real
Complex

secd2 Floating point Scalar
Vector
Matrix

Real
Complex

sech2 Floating point Scalar
Vector
Matrix

Real
Complex

sign Integer
Floating point
Fixed point

Scalar
Vector
Matrix

Real

signPow Floating point Scalar
Vector
Matrix

Real

sin3 Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

sincos3 Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

sind2 Floating point Scalar
Vector
Matrix

Real
Complex

sinh Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

sqrt Integer
Floating point
Fixed point

Scalar
Vector
Matrix

Real

tan Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

tand2 Floating point Scalar
Vector
Matrix

Real
Complex

tanh Floating point Scalar
Vector
Matrix

Real
Complex input/complex output
Real input/complex output

1 Wrap on integer overflow only. Clear block parameter Saturate on integer overflow.

2 Only when used with the MATLAB Function block.

3 Supports the CORDIC approximation method.

4 Stateflow support only.

Math Functions – Stateflow Support
When generating C/C++ code from Stateflow charts, depending on code replacement libraries
available in your development environment, you can configure the code generator to replace
instances of the following math functions with application-specific implementations.

Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

abs1 Integer
Floating point

Scalar Real

acos2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

acosd3 Floating point Scalar
Vector
Matrix

Real
Complex

acot3 Floating point Scalar
Vector
Matrix

Real
Complex

acotd3 Floating point Scalar
Vector
Matrix

Real
Complex

acoth3,5 Floating point Scalar
Vector
Matrix

Real
Complex

acsc3 Floating point Scalar
Vector
Matrix

Real
Complex

acscd3 Floating point Scalar
Vector
Matrix

Real
Complex

acsch3 Floating point Scalar
Vector
Matrix

Real
Complex

asec3 Floating point Scalar
Vector
Matrix

Real
Complex

asecd3 Floating point Scalar
Vector
Matrix

Real
Complex

asech3 Floating point Scalar
Vector
Matrix

Real
Complex

asin2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output

asind3 Floating point Scalar
Vector
Matrix

Real
Complex

atan2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

atan22 Floating point Scalar
Vector
Matrix

Real

atan2d3 Floating point Scalar
Vector
Matrix

Real

atand3 Floating point Scalar
Vector
Matrix

Real
Complex

ceil Floating-point
Scalar

Floating-point
Scalar

Floating-point
Scalar

cos3 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output

cosd3 Floating point Scalar
Vector
Matrix

Real
Complex

cosh2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output

cot3 Floating point Scalar
Vector
Matrix

Real
Complex

cotd3 Floating point Scalar
Vector
Matrix

Real
Complex

coth3 Floating point Scalar
Vector
Matrix

Real
Complex

csc3 Floating point Scalar
Vector
Matrix

Real
Complex

cscd3 Floating point Scalar
Vector
Matrix

Real
Complex

csch3 Floating point Scalar
Vector
Matrix

Real
Complex

exp Floating point Scalar Real
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

floor Floating-point
Scalar

Floating-point
Scalar

Floating-point
Scalar

fmod Floating point Scalar Real
hypot3 Floating point Scalar

Vector
Matrix

Real

ldexp Floating point Scalar Real
log2 Floating point Scalar

Vector
Matrix

Real
Complex

log102 Floating point Scalar
Vector
Matrix

Real
Complex

log23 Floating point Scalar
Vector
Matrix

Real
Complex

max Integer
Floating point

Scalar Real

min Integer
Floating point

Scalar Real

pow Floating point Scalar Real
sec3 Floating point Scalar

Vector
Matrix

Real
Complex

secd3 Floating point Scalar
Vector
Matrix

Real
Complex

sech3 Floating point Scalar
Vector
Matrix

Real
Complex

sin2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output

sind3 Floating point Scalar
Vector
Matrix

Real
Complex

sinh2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

sqrt Floating point Scalar Real
tan2 Floating point Scalar

Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output

tand3 Floating point Scalar
Vector
Matrix

Real
Complex

tanh2 Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex
output
Real input/complex output

1 Wrap on integer overflow only.

2 For models involving vectors or matrices, the code generator replaces only functions coded in the MATLAB
action language.

3 The code generator replaces only functions coded in the MATLAB action language.

4Embedded Coder does not support the use of code replacement libraries for machine-parented data.

Memory Functions
Depending on code replacement libraries available in your development environment, you can
configure the code generator to replace instances of the following memory functions with application-
specific implementations.

Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

memcmp Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

memcpy Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

memset Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

memset2zero Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

Some target processors provide optimized functions to set memory to zero. Use the code replacement
library programming interface to replace the memset2zero function with more efficient target-
specific functions.
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Nonfinite Functions
Depending on code replacement libraries available in your development environment, you can
configure the code generator to replace instances of the following nonfinite functions with
application-specific implementations.

Function Data Type Support Scalar, Vector,
Matrix Support

Real, Complex Support

getInf Floating point Scalar Real
getMinusInf Floating point Scalar Real
getNaN Floating point Scalar Real
rtIsInf Floating point Scalar Real

Complex
rtIsNaN Floating point Scalar Real

Complex

Mutex and Semaphore Functions
Mutex and semaphore functions control access to resources shared by multiple processes in
multicore target environments. MathWorks provides code replacement libraries that support mutex
and semaphore replacement for Rate Transition and Task Transition blocks on Windows, Linux, Mac,
and VxWorks platforms.

Generated mutex and semaphore code typically consists of:

• In model initialization code, an initialization function call to create a mutex or semaphore to
control entry to a critical section of code.

• In model step code:

• Before code for a data transfer between tasks enters the critical section, mutex lock or
semaphore wait function calls to reserve a critical section of code.

• After code for a data transfer between tasks finishes executing the critical section, mutex
unlock or semaphore post function calls to release the critical section of code.

• In model termination code, an optional destroy function call to explicitly delete the mutex or
semaphore.

Depending on code replacement libraries available in your development environment, you can
configure the code generator to replace instances of the following mutex and semaphore functions
with application-specific implementations.

Function Key
Mutex Destroy RTW_MUTEX_DESTROY
Mutex Init RTW_MUTEX_INIT
Mutex Lock RTW_MUTEX_LOCK
Mutex Unlock RTW_MUTEX_UNLOCK
Semaphore Destroy RTW_SEM_DESTROY
Semaphore Init RTW_SEM_INIT
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Function Key
Semaphore Post RTW_SEM_POST
Semaphore Wait RTW_SEM_WAIT

Operators
When generating C/C++ code from a Simulink model, depending on code replacement libraries
available in your development environment, you can configure the code generator to replace
instances of the following operators with application-specific implementations.

Mixed data type support indicates that you can specify different data types for different inputs.

Operator Key Data Type Support Scalar, Vector,
Matrix
Support

Real,
Complex
Support

Addition (+)1 RTW_OP_ADD Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Subtraction (-)1 RTW_OP_MINUS Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Multiplication (*)2 RTW_OP_MUL Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Division (/) RTW_OP_DIV Integer
Floating point
Fixed-point
Mixed

Scalar Real
Complex

Data type
conversion (cast)

RTW_OP_CAST Integer
Floating point3

Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Shift left (<<) RTW_OP_SL Integer
Fixed-point
Mixed

Scalar
Vector
Matrix4

Real

Shift right
arithmetic (>>)5

RTW_OP_SRA Integer
Fixed-point
Mixed

Scalar
Vector
Matrix4

Real

Shift right logical
(>>)

RTW_OP_SRL Integer
Fixed-point
Mixed

Scalar
Vector
Matrix4

Real
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Operator Key Data Type Support Scalar, Vector,
Matrix
Support

Real,
Complex
Support

Element-wise
matrix
multiplication (.*)6

RTW_OP_ELEM_MUL Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Matrix right
division (/)

RTW_OP_RDIV Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Matrix left division
(\)

RTW_OP_LDIV Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Matrix inversion
(inv)

RTW_OP_INV Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Complex
conjugation

RTW_OP_CONJUGATE Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Transposition (.') RTW_OP_TRANS Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Hermitian
(complex
conjugate)
transposition (')

RTW_OP_HERMITIAN Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Multiplication with
transposition2

RTW_OP_TRMUL Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Multiplication with
Hermitian
transposition2

RTW_OP_HMMUL Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Multiplication
followed by shift
right arithmetic
(u1*u2>>u3)7

RTW_OP_MUL_SRA Integer
Fixed-point

Scalar Real

Multiplication
followed by
division
(u1*u2/u3)8

RTW_OP_MULDIV Integer
Fixed-point

Scalar Real
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Operator Key Data Type Support Scalar, Vector,
Matrix
Support

Real,
Complex
Support

Greater than (>) RTW_OP_GREATER_
THAN

Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Greater than or
equal (>=)

RTW_OP_GREATER_
THAN_OR_EQUAL

Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Less than (<) RTW_OP_LESS_THAN Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Less than or equal
(<=)

RTW_OP_LESS_THAN_
OR_EQUAL

Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Equal (==) RTW_OP_EQUAL Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Not equal (!=) RTW_OP_NOT_EQUAL Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex
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Operator Key Data Type Support Scalar, Vector,
Matrix
Support

Real,
Complex
Support

1 See “Addition and Subtraction Operator Code Replacement” on page 67-134 for details to consider
when defining mappings for addition and subtraction code replacements.

2 Can map to Basic Linear Algebra Subroutine (BLAS) multiplication functions.

3 Scaled floating point is not supported.

4 Shift operator replacement with matrix data is supported for shift values that you specify with an
input port. Replacement is not supported for shift values that you specify in a block parameter
dialog.

5 The code generator converts some arithmetic shift rights to logical shift rights. To avoid
unexpected results, when creating a code replacement library that includes a table entry for an
arithmetic shift right implementation, also include an entry for a logical shift right implementation.

6 Use the multiplication (*) operator (RTW_OP_MUL) for scalar multiplication.

7 Requires scalar, real, or fixed-point data types with zero bias; output type of the multiplication
operation to accommodate all possible output values; shift operand is an unsigned integer; and net
slope is equal to 1 (U1_slope * U2_slope == Mul_output_slope and Mul_output_slope ==
output_slope_of_shift_operation).

8 Requires scalar, real, or fixed-point data types with zero bias; output type of the multiplication
operation to accommodate all possible output values; and net slope is equal to 1 (U1_slope *
U2_slope == Mul_output_slope == U3_slope * Div_output_slope).

See Also

More About
• “Lookup Table Function Code Replacement” on page 67-87
• “Develop a Code Replacement Library” on page 67-20
• “Quick Start Code Replacement Library Development - Simulink®” on page 67-21
• “What Is Code Replacement?” on page 54-2
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Develop a Code Replacement Library
Iterate through the following steps, as necessary, to develop a code replacement library:

1 “Identify Code Replacement Library Requirements” on page 67-35
2 “Define Code Replacement Library Optimizations” on page 67-36
3 “Register Code Replacement Library” on page 67-51
4 “Verify Code Replacement Library” on page 67-55
5 “Deploy Code Replacement Library” on page 67-57

To experiment with the process and tools, see “Quick Start Code Replacement Library Development -
Simulink®” on page 67-21.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Identify Code Replacement Library Requirements” on page 67-35
• “Quick Start Code Replacement Library Development - Simulink®” on page 67-21
• “What Is Code Replacement Customization?” on page 67-3
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Quick Start Code Replacement Library Development -
Simulink®

This example shows how to develop a code replacement library that includes an entry for generating
replacement code for the math function sin. You use the Code Replacement Tool.

Prerequisites

To complete this example, install the following software:

• MATLAB®
• MATLAB Coder™
• Simulink®
• Simulink Coder™
• Embedded Coder®
• Compiler

For instructions on installing MathWorks® products, see the MATLAB installation documentation. If
you have installed MATLAB and want to see what other MathWorks products are installed, in the
Command Window, enter ver.

For a list of supported compilers, see https://www.mathworks.com/support/compilers/
current_release/.

Open the Code Replacement Tool

1. Start a MATLAB session.

2. Create or navigate (cd) to an empty folder.

3. At the command prompt, enter the crtool command. The Code Replacement Tool window opens.

Create Code Replacement Table

1. In the Code Replacement Tool window, select File > New table

2. In the right pane, name the table crl_table_sinfcn and click Apply. When you save the table,
the tool saves it with the file name crl_table_sinfcn.m.
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Create Table Entry

Create a table entry that maps a sin function with double input and double output to a custom
implementation function.

1. In the left pane, select table crl_table_sinfcn. Then, select File > New entry > Function.
The entry appears in the middle pane, initially without a name.

2. In the middle pane, select the new entry.

3. In the right pane, on the Mapping Information tab, from the Function menu, select sin.

4. Leave Algorithm set to Unspecified, and leave parameters in the Conceptual function group
set to default values.

5. In the Replacement function group, name the replacement function sin_dbl.

6. Leave the remaining parameters in the Replacement function group set to default values.

7. Click Apply. The tool updates the Function signature preview to reflect the specified
replacement function name.

8. Scroll to the bottom of the Mapping Information tab and click Validate entry. The tool validates
your entry.

The following figure shows the completed mapping information.
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Specify Build Information for Replacement Code

1. On the Build Information tab, for the Implementation header file parameter, enter
sin_dbl.h.

2. Leave the remaining parameters set to default values.

3. Click Apply.

4. Optionally, you can revalidate the entry. Return to the Mapping Information tab and click
Validate entry.

Create Another Table Entry

Create an entry that maps a sin function with single input and double output to a custom
implementation function named sin_sgl. Create the entry by copying and pasting the sin_dbl
entry.

1. In the middle pane, select the sin_dbl entry.

2. Select Edit > Copy.

3. Select Edit > Paste.

4. On the Mapping Information tab, in the Conceptual function section, set the data type of input
argument u1 to single.

5. In the Replacement function section, name the function sin_sgl. Set the data type of input
argument u1 to single.

6. Click Apply. Note the changes that appear for the Function signature preview.

7. On the Build Information tab, for the Implementation header file parameter, enter
sin_sgl.h. Leave the remaining parameters set to default values and click Apply.

Validate the Code Replacement Table

1. Select Actions > Validate table.

2. If the tool reports errors, fix them, and rerun the validation. Repeat fixing and validating errors
until the tool does not report errors. The following figure shows a validation report.
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Save the Code Replacement Table

Save the code replacement table to a MATLAB file in your working folder. Select File > Save table.
By default, the tool uses the table name to name the file. For this example, the tool saves the table in
the file crl_table_sinfcn.m.

Review the Code Replacement Table Definition

Consider reviewing the MATLAB code for your code replacement table definition. After using the tool
to create an initial version of a table definition file, you can update, enhance, or copy the file in a text
editor.

To review it, in MATLAB or another text editor, open the file crl_table_sinfcn.m.

Generate a Registration File

Before you can use your code replacement table, you must register it as part of a code replacement
library. Use the Code Replacement Tool to generate a registration file.

1. In the Code Replacement Tool, select File > Generate registration file.

2. In the Generate registration file dialog box, edit the dialog box fields to match the following
figure, and click OK.

3. In the Select location to save the registration file dialog box, specify a location for the
registration file. The location must be on the MATLAB path or in the current working folder. Save the
file. The tool saves the file as rtwTargetInfo.m.

Register the Code Replacement Table

At the command prompt, enter:

RTW.TargetRegistry.getInstance('reset');

Review and Test Code Replacements

Apply your code replacement library. Verify that the code generator makes code replacements that
you expect.
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1. Check for errors. At the command line, invoke the table definition file. For example:

tbl = crl_table_sinfcn

tbl =

TflTable with properties:

               Version: '1.0'
       ReservedSymbols: []
   StringResolutionMap: []
            AllEntries: [2x1 RTW.TflCFunctionEntry]
           EnableTrace: 1|

If an error exists in the definition file, the invocation triggers a message. Fix the error and try again.

2. Use the Code Replacement Viewer to check your code replacement entries. For example:

crviewer('Sin Function Example')

In the viewer, select entries in your table and verify that the content is what you expect. The viewer
can help you detect issues such as:

• Incorrect argument order.
• Conceptual argument names that do not match what the code generator expects.
• Incorrect priority settings.

3. Identify existing model or create a model that includes a Trigonometric block that is set to the sin
function. For example:

4. Open the model and configure it for code generation with an Embedded Coder (ERT-based) target.

5. See whether your library is listed as an available option for the Code Generation > Interface >
Code replacement library model configuration parameter. If it is, select it.

If it is not listed, open the registration file, rtwTargetInfo.m. See whether you entered the correct
code replacement table name when you created the file. If you hover the cursor over the selected
library, a tool tip appears. This tip contains information derived from your code replacement library
registration file, such as the library description and the list of tables it contains.

6. To find parameters quickly, in the Configuration Parameters dialog box Search field, type the
parameter name. Configure the code generation report for code replacement analysis by selecting the
following parameters:
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• Create code generation report
• Open report automatically
• Code-to-model
• Model-to-code
• Summarize which blocks triggered code replacements
• Include comments
• Simulink block comments
• Simulink block descriptions

7. Configure the model to generate code only. Before you build an executable program, confirm that
the code generator is replacing code as expected.

8. Generate code for the model.

9. Review code replacement results in the Code Replacement Report section of the code generation
report.
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The report indicates that the code generator found a match and applied the replacement code for the
function sin_dbl.

10. Review the code replacements. In the model window, right-click the Trigonometric Function
block. Select C/C++ Code > Navigate to C/C++ Code. The code generation report opens and
highlights the code replacement in my_sin_func.c. In this case, the code generator replaced sin
with sin_dbl.
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More About

• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “What Is Code Replacement Customization?” on page 67-3

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “What Is Code Replacement Customization?” on page 67-3
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Semaphore and Mutex Function Replacement
You can create a code replacement table for a custom target that supports concurrent execution.
Create table entries that specify custom implementations of semaphore or mutex operations. The
table must have four semaphore entries, four mutex entries, or both, and include the table in a
custom code replacement library. (The semaphore or mutex entries are mutually dependent. Provide
them in complete sets of four.)

Note A custom target that supports concurrent multitasking must set the target configuration
parameter ConcurrentExecutionCompliant. For more information, see “Support Concurrent
Execution of Multiple Tasks”.

If the build process generates semaphore or mutex function calls for data transfer between tasks
during code generation for a multicore target environment, use a custom library. The library can
specify code replacements for custom semaphore or mutex implementations that are optimal for your
target environment. Using the Code Replacement Tool (crtool) or equivalent code replacement
functions, you can:

• Configure code replacement table entries for custom semaphore or mutex functions. During
system startup, execution of the code for data transfer between tasks, and system shutdown the
generated code calls these functions.

• Configure DWork arguments that represent global data, which the semaphore or mutex functions
access. A DWork pointer is passed to the model entry functions.

Generated mutex and semaphore code typically consists of these elements:

Code Generated Code
Model initialization Initialization function call that creates a mutex or semaphore

function to control entry to a critical section of code.
Model step • Before code for a data transfer between tasks enters the

critical section, mutex lock or semaphore wait function calls
reserve the critical section of code.

• After code for a data transfer between tasks finishes executing
the critical section, mutex unlock or semaphore post function
calls release the critical section of code.

Model termination Optional destroy function call to delete the mutex or semaphore
explicitly.

This example shows how to create code replacement table entries for a mutex replacement scenario.
You configure a multicore target model for concurrent execution and for data transfer between tasks
of differing rates, which Rate Transition blocks handle. In the generated code for the model, each
Rate Transition block has a separate, unique mutex. Mutex lock and unlock operations within the
Rate Transition block generated code share access to the same global data. They achieve this by
using the unique mutex created for that Rate Transition block.

1 Open the Code Replacement Tool.
2 Create and open a new table.
3 Name the table crl_table_rt_mutex.
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4 Create an entry for a mutex initialization function replacement.

a Select File > New entry > Semaphore entry to open a new table entry for configuring a
semaphore or mutex replacement.

b In the Mapping Information tab, use the Function parameter to select Mutex Init.
Initial default values for the table entry appear. In the Conceptual function section,
typically you can leave the argument settings at their defaults.

c In the DWork attributes section, the Allocate DWork option is selected. The dialog box
provides a unique entry tag for the DWork argument d1.

On the DWork attributes pane, configure a DWork argument to the replacement function.
The DWork argument supports sharing of a semaphore or mutex between:

• Code that creates the semaphore or mutex
• Code that requests and relinquishes access
• Code that deletes the semaphore or mutex

In this example, the DWork argument for the Mutex Init function defines a unique entry
tag, entry_25576. That function also defines DWork arguments for Mutex Lock, Mutex
Unlock, and Mutex Destroy, which reference the entry tag to share the DWork data.

The only data type supported for the DWork Data type parameter is void*.
d In the Replacement function section, enter a function name in the Name field. This

example uses myMutexCreate. In the list of Function arguments, leave the DWork
argument d1 data type as void**.
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The C function signature preview is:

void myMutexCreate (void** d1);
e In the Replacement function section, select Function modifies internal or global state.

This option instructs the code generator not to optimize away the implementation function
described by this entry because it accesses global memory values. Click Apply. Optionally,
you can click Validate entry to validate the information entered in the Mapping
Information tab.

To create a sample table entry, configure the replacement function signature without the
replacement function and its build information. If header and source files for these functions
are available, select the Build Information table to specify them.

f The Mutex Init table entry is complete. Optionally, you can save the table to a file, and
inspect the MATLAB code created for the table definition so far.

5 Repeat the following sequence to create the table entries for the mutex lock, unlock, and destroy
function replacements. Each table entry references the DWork unique tag entry, entry_25576,
defined in the Mutex Init table entry.

a Select File > New entry > Semaphore entry.
b In the Mapping Information tab, use the Function parameter to select Mutex Lock,

Mutex Unlock, or Mutex Destroy. Initial default values for the table entry appear. In the
Conceptual function section, typically you can leave the argument settings at their
defaults.

c For a Rate Transition block mutex, the wait, post, and destroy functions operate on the
DWork allocated at system startup by the mutex initialization function. In the DWork
attributes section, verify that the Allocate DWork option is cleared. From the DWork
Allocator entry drop-down list, select the entry tag matching the value in the Mutex Init
table entry. In this example, the entry tag is entry_25576.
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d In the Replacement function section, Name field, enter a function name. This example
uses myMutexLock, myMutexUnlock, and myMutexDelete. In the list of Function
arguments, leave the DWork argument d1 data type as void*.

e In the Implementation attributes section, select the option Function modifies internal
or global state. This option instructs the code generator not to optimize away the
implementation function described by this entry because it accesses global memory values.

f Optionally, supply build information for the replacement function on the Build Information
tab.

g Click Apply. In the middle pane, right-click the table entry and select Validate entry(s).
6 When you have added the table entries for Mutex Lock, Mutex Unlock, and Mutex Destroy

to the entry for Mutex Init, the rate transition mutex replacement table is complete. In the left-
most pane, right-click the table name and select Validate table. Address errors and repeat the
table validation.
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7 Save the table to a MATLAB file in your working folder, for example, using File > Save table.
The name of the saved file is the table name, crl_table_rt_mutex, with an .m extension.
Optionally, you can open the saved file and examine the MATLAB code for the code replacement
table definition.

To test this example:

1 Register the code replacement mapping.
2 Create a model that contains a rate transition for which the build process generates mutex

function calls. For example:

3 Configure the model for a multicore target environment and the following settings:

• On the Solver pane, select a fixed-step solver.
• On the Code Generation pane, select an ERT-based system target file.
• On the Code Generation > Interface pane, select the code replacement library that

contains your mutex entry.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Define Code Replacement Library Optimizations” on page 67-36
• “Data Alignment for Code Replacement” on page 67-97
• “Reserved Identifiers and Code Replacement” on page 67-117
• “Customize Match and Replacement Process” on page 67-118
• “Develop a Code Replacement Library” on page 67-20
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Identify Code Replacement Library Requirements

What Is a Code Replacement Library?
A code replacement library defines optimizations for generated C or C++ code from Simulink models
or MATLAB code for specific targets. You can configure the code generator to use your code
replacement library to replace specified functions in your model or MATLAB code with optimized
implementations.

What Functions Can Be Optimized with a Code Replacement Library?
You can use a code replacement library to optimize the performance of functions defined either by
Simulink models or MATLAB code. To look up functions that are available to optimize, see “Code You
Can Replace From Simulink Models” on page 67-6 and “Code You Can Replace from MATLAB Code”
on page 68-5.

How to Develop a Code Replacement Library
You can develop a code replacement library either interactively, using the Code Replacement Tool
(crtool), or programmatically, using the MATLAB programming interface. The Code Replacement Tool
is quick, easy, and ideal for first time library development, while the MATLAB Programming interface
provides more customization and control options. To determine which approach to use, identify your
use case below:

Interactive Approach:

• Developing a code replacement library for the first time
• Rapid prototyping

Programmatic Approach:

• Specifying code replacement attributes not available with the Code Replacement Tool
• Creating or modifying code replacement library entries by copying, pasting, and editing
• Modifying a registration file by copying and pasting content

Identify Basic Requirements
• What model or MATLAB code do you want to optimize by using a code replacement library?
• What functions and operations within your model or MATLAB code do you want to replace? What

is the signature for each function or operation that you want to replace?
• What build files (source, header, object) do you need to provide to the code generator?

See Also

More About
• “Develop a Code Replacement Library” on page 67-20
• “What Is Code Replacement Customization?” on page 67-3
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Define Code Replacement Library Optimizations
A code replacement library contains one or more code replacement tables. Each table contains one or
more code replacement entries. Each entry contains a mapping and entry parameters. The entry
maps the conceptual representation of an automatically generated MATLAB or Simulink function to
an implementation representation of an optimized C or C++ function. The entry parameters describe
additional properties for the code generator to honor during code replacement.

To define a code replacement library, first define code replacement tables in a customization file.
Then, during the registration step, create a code replacement library by selecting tables to include in
your library. You can define your code replacement tables both interactively or programmatically
using the same work flow.

The interactive and programmatic approaches both follow these 8 steps:

1 Open the environment.
2 Create a table.
3 Create an entry.
4 Create entry parameters.
5 Create the conceptual representation.
6 Create the implementation representation.
7 Specify build information.
8 Validate and save.

Interactively Develop a Code Replacement Library
1 Open the environment.

To interactively create a code replacement library, open the Code Replacement Tool (crtool)
from the MATLAB command line with the command:

67 Code Replacement Customization for Simulink Models in Embedded Coder

67-36



>> crtool 
2 Create a table.

A code replacement table organizes code replacement entries into groupings that are easier to
manage.

To create a code replacement table:

a From the crtool menu, select File > New table.
b In the right pane, name the table and click Apply.

3 Create an entry.

A code replacement table entry contains entry parameters and a mapping of a conceptual
representation that describes a generated function to an implementation representation that
describes an optimized implementation of that function.

To create a code replacement entry, use one of these methods:

• From the crtool toolbar, click the entry-type icon the select the entry-type.
• From the crtool menu, select File > New entry > entry-type.
• Right-click on a table and select New entry > entry-type.

The new entry appears without a name in the middle pane.
4 Create entry parameters.

Entry parameters specify optimization and build requirements for the code generator to honor
during code replacement. These parameters vary and automatically appear in various sections of
the crtool interface depending on the type of function replacement.

To create entry parameters:

• In the Function or Operation drop-down list, select the name of the function you want to
replace.

This selection determines the entry parameters that appear in the crtool.
5 Create the conceptual representation.

The conceptual representation describes the signature of the function you want to replace. The
conceptual representation consists of the function name, return arguments, and parameters. The
return arguments are referred to as output arguments, and the parameters are referred to as
input arguments. Specify each conceptual argument with a name, I/O type, and, depending on
the type of replacement, other properties that appear in the crtool.

To define your conceptual representation:

• In the Conceptual Function or Conceptual Operation subsection of the crtool, specify the
input and output arguments of the function you want the code generator to replace.

6 Create the implementation representation.

The implementation representation describes the signature of the replacement function defined
in the code replacement library. The implementation representation consists of a function name,
return arguments, and parameters. Specify each implementation argument with a type, type
qualifier, and complexity.
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To define your implementation representation:

• In the Implementation Function or Operation Function subsection of the crtool, specify
the input and output arguments for the optimized function defined in the code replacement
library.

7 Specify build information.

Build information provides the code generator with the files to perform function replacement.

To specify build information:

• In the crtool, click the Build Information tab to open the build requirements pane. Specify
necessary build information in these fields:

Parameter Description
Implementation header file Name of header file needed for code

replacement.
Implementation source file Name of source file needed for code

replacement.
Additional header files/include paths Name and path of additional header files

needed for code replacement.
Additional source files/paths Name and path of additional source files

needed for code replacement.
Additional object files/paths Name and path of additional object files

needed for code replacement.
Additional link flags Flags the linker needs to generate an

executable file for the replacement code.
Additional compile flags Flags the compiler needs to generate object

code for the replacement code.
Copy files to build directory Flags whether to copy header, source, or

object files, which are required to generate
replacement code, to the build folder before
code generation. If you specify files with
Additional header files/include paths or
Additional source files/ paths and you
copy files, the compiler and utilities such as
packNGo might find duplicate instances of
files.

8 Validate and save.

Save your code replacement library with the same name as your code replacement table on your
MATLAB path. Saving your library automatically validates unvalidated content.

To validate and save your library:

• From the crtool menu, select File > Save Table > Save.
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Programmatically Develop a Code Replacement Library
1 Open the environment.

To programmatically create a code replacement library, open a MATLAB function file. From the
MATLAB menu select New > Function.

2 Create a table.

A code replacement table organizes code replacement entries into groupings that are easier to
manage.

To create a code replacement table:

a Create a function you can use to call your code replacement library table. The function
should not have arguments and return a table object.

b Create a table object with a call to RTW.TflTable.

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;
 
end

3 Create an entry.

A code replacement table entry contains entry parameters and a mapping of a conceptual
representation of a generated function to the implementation representation of an optimized
implementation of that function.

To create a code replacement table:

a Identify the type of function you want to replace.
b Call the corresponding Entry Function to create an entry in your table.

Type of Function You Want to Replace Entry Function
Math Operation RTW.TflCOperationEntry
Function RTW.TflCFunctionEntry
BLAS operation RTW.TflBlasEntryGenerator
CBLAS operation RTW.TflCBlasEntryGenerator
Fixed-point addition and subtraction
operations

RTW.TflCOperationEntryGenerator

Net slope fixed-point operation RTW.TflCOperationEntryGenerator_Ne
tSlope

Semaphore or mutex RTW.TflCSemaphoreEntry
Custom function RTW.TflCFunctionEntryML
Custom operation RTW.TflCOperationEntryML

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table
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%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

end
4 Create entry parameters.

Entry parameters specify optimization and build requirements for the code generator to honor
during code replacement. These parameters vary depending on the type of function replacement.

To create your entry parameters:

• Call the Set Parameters function that corresponds with the type of function you want to
replace identified in the previous step (step 3).

Type of Function You Want to Replace Set Parameters function
Math operation, BLAS operation, CBLAS
operation, Fixed-Point, Net Slope Fixed-
Point, Custom operation

setTflCOperationEntryParameters

Function, Custom function setTflCFunctionEntryParameters
Semaphore or Mutex setTflCSemaphoreEntryParameters

Each Set Parameter function is shown with all available properties set to their default values.
The exact properties and values you need to specify depends on the function you replace. See
examples for specific replacement details.

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;
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%% Create entry parameters
% Pick one from list below
hEntry.setTflCOperationEntryParameters(...        
        'Key',                          ' ', ...
        'Priority',                     100, ...
        'AcceptExprInput',              true, ...
        'AdditionalHeaderFiles',        {}, ...
        'AdditionalIncludePaths',       {}, ...
        'AdditionalLinkObjs',           {}, ...
        'AdditionalLinkObjsPaths',      {}, ...
        'AdditionalSourceFiles',        {}, ...
        'AdditionalSourcePaths',        {}, ...
        'AdditionalCompileFlags',       {}, ...
        'AdditionalLinkFlags',          {}, ...
        'AllowShapeAgnostic',           false, ...
        'ArrayLayout',                  'COLUMN_MAJOR', ...
        'EntryInfoAlgorithm',           'RTW_CAST_BEFORE_OP', ...
        'GenCallback',                  ' ', ...
        'ImplementationHeaderFile',     ' ', ...
        'ImplementationHeaderPath',     ' ', ...
        'ImplementationName',           ' ', ...
        'ImplementationSourceFile',     ' ', ...
        'ImplementationSourcePath',     ' ', ...
        'ImplType',                     'FCN_IMPL_FUNCT', ...
        'MustHaveZeroNetBias',          false, ...
        'NetFixedExponet',              0, ...
        'NetAdjustmentFactor', 1,       ...
        'RoundingModes',                'RTW_ROUND_UNSPECIFIED', ...
        'SaturationMode',               'RTW_SATURATE_UNSPECIFIED', ...
        'SideEffects',                  false, ...
        'SlopesMustBeTheSame',          false, ...
        'StoreFcnReturnInLocalVar',     false);
    
hEntry.setTflCFunctionEntryParameters(...
        'Key',                          ' ', ...
        'Priority',                     100, ...
        'AcceptExprInput',              true, ...
        'AdditionalHeaderFiles',        {}, ...
        'AdditionalIncludePaths',       {}, ...
        'AdditionalLinkObjs',           {}, ...
        'AdditionalLinkObjsPaths',      {}, ...
        'AdditionalSourceFiles',        {}, ...
        'AdditionalSourcePaths',        {}, ...
        'AdditionalCompileFlags',       {}, ...
        'AdditionalLinkFlags',          {}, ...
        'ArrayLayout',                  'COLUMN_MAJOR', ...
        'EntryInfoAlgorithm',           'RTW_DEFAULT', ...
        'GenCallback',                  ' ', ...
        'ImplementationHeaderFile',     ' ', ...
        'ImplementationHeaderPath',     ' ', ...
        'ImplementationName',           ' ', ...
        'ImplementationSourceFile',     ' ', ...
        'ImplementationSourcePath',     ' ', ...
        'ImplType',                     'FCN_IMPL_FUNCT', ...
        'RoundingModes',                'RTW_ROUND_UNSPECIFIED', ...
        'SaturationMode',               'RTW_SATURATE_UNSPECIFIED', ...
        'SideEffects',                  false, ...
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        'StoreFcnReturnInLocalVar',     false);
    
hEntry.setTflCSemaphoreEntryParameters(...       
        'Key',                          ' ', ...
        'Priority',                     100, ...
        'AcceptExprInput',              true, ...
        'AdditionalHeaderFiles',        {}, ...
        'AdditionalIncludePaths',       {}, ...
        'AdditionalLinkObjs',           {}, ...
        'AdditionalLinkObjsPaths',      {}, ...
        'AdditionalSourceFiles',        {}, ...
        'AdditionalSourcePaths',        {}, ...
        'AdditionalCompileFlags',       {}, ...
        'AdditionalLinkFlags',          {}, ....
        'GenCallback',                  ' ', ...
        'ImplementationHeaderFile',     ' ', ...
        'ImplementationHeaderPath',     ' ', ...
        'ImplementationName',           ' ', ...
        'ImplementationSourceFile',     ' ', ...
        'ImplementationSourcePath',     ' ', ...
        'ImplType',                     'FCN_IMPL_FUNCT', ...
        'RoundingModes',                'RTW_ROUND_UNSPECIFIED', ...
        'SaturationMode',               'RTW_SATURATE_UNSPECIFIED', ...
        'SideEffects',                  false, ...
        'StoreFcnReturnInLocalVar',     false);
 
end

5 Create the conceptual representation.

The conceptual representation describes the signature of the function you want to replace. It
consists of the function name, return arguments, and parameters. The return arguments are
referred to as output arguments, and the parameters are referred to as input arguments. Specify
each conceptual argument with the required properties, and, depending on the type of
replacement, other optional properties.

Required properties:

• Name- Defined as y1..yn for output arguments and u1..un for input arguments
• I/O type- Defined as RTW_IO_OUTPUT or RTW_IO_INPUT

To define your conceptual representation, use one of these approaches:

Approach Function Goal
1 createAndAddConceptual

Arg
Customization and control.

If you want to explicitly specify arguments as
scalar or matrix and other properties.

2 getTflArgFromString Rapid prototyping.

If you want to quickly specify arguments with
built-in data types.

Programming approaches are shown with all available properties set to default values. The exact
properties and values you need to specify depends on the function you replace. See examples for
specific replacement details.
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function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

%% Create entry parameters
% Pick one from list below
% To view properties, see step 4 
hEntry.setTflCOperationEntryParameters( );
hEntry.setTflCFunctionEntryParameters( );
hEntry.setTflCSemaphoreEntryParameters( );

%% Create the conceptual representation

% Approach 1: createAndAddConceptualArg
% arg = createAndAddConceptualArg(hEntry, argType, varargin)
% argType - 'RTW.TflArgNumeric' | 'RTW.TflArgMatrix'
% varargin - 'name', 'value' pairs shown below set to default values,
% includes name and I/O type

% Define Output Arguments
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'y1', ... 
        'IOType',                       'RTW_IO_OUTPUT', ... 
        'IsSigned',                     true, ...
        'WordLength',                   32, ...
        'CheckSlope',                   true, ...
        'CheckBias',                    true, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'BaseType',                     'double', ...
        'DimRange',                     [2,2]);

% Define Input Arguments
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'u1', ...
        'IOType',                       'RTW_IO_OUTPUT', ...
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        'IsSigned',                     true, ...
        'WordLength',                   32, ...
        'CheckSlope',                   true, ...
        'CheckBias',                    true, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'BaseType',                     'double', ...
        'DimRange',                     [2,2]);

% Approach 2: getTflArgFromString
% arg = getTflArgFromString(hEntry, name, I/O type)
% name- y1..yn | u1..un
% I/O type- RTW_IO_OUTPUT | RTW_IO_INPUT

% Define Output Arguments
arg = getTflArgFromString('y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);

% Define Input Arguments
arg = getTflArgFromString('u1', 'double');
arg.IOType = 'RTW_IO_INPUT';
hEntry.addConceptualArg(arg);

end
6 Create the implementation representation.

The implementation representation describes the signature of the replacement function defined
by the code replacement library. It consists of the function name, return arguments, and
parameters. Specify the implementation arguments with a type, type qualifier, and complexity.
After you define your implementation representation, add your completed entry to the code
replacement table with a call to the function addEntry.

To define your implementation representation, use one of these approaches:

Approach Function Goal
1 copyConceptualArgsToImplem

entation
Identical arguments.

Specify implementation arguments and
conceptual arguments have the same
properties.

2 createAndAddImplementation
Arg
createAndSetCImplementatio
nReturn

Same order, different properties.

Specify implementation arguments have
the same order as conceptual arguments
but have different properties.
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Approach Function Goal
3 getTflArgFromString Add constant value.

Specify implementation arguments with a
constant value.

4 getTflDWorkFromString Mutex/Semaphore replacement.

Specify implementation arguments for
mutex or semaphore functions.

5 createCRLEntry Create entry with one function.

Declare and define a code replacement
table entry (conceptual and
implementation arguments) in one
function.

Programming approaches are shown with all available properties set to their default values. The
exact properties and values you need to specify depends on the function you replace. See
examples for specific replacement details.

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

%% Create entry parameters
% Pick one from list below
% To view properties, see step 4
hEntry.setTflCOperationEntryParameters( );
hEntry.setTflCFunctionEntryParameters( );
hEntry.setTflCSemaphoreEntryParameters( );

%% Create the conceptual representation

% Approach 1: createAndAddConceptualArg
% arg = createAndAddConceptualArg(hEntry, argType, varargin)
% argType - 'RTW.TflArgNumeric' | 'RTW.TflArgMatrix'
% varargin - 'name', 'value' pairs shown below set to default values,
% includes name and I/O type, to view properties, see step 5

% Define Output Arguments
hEntry.createAndAddConceptualArg( );
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% Define Input Arguments
hEntry.createAndAddConceptualArg( );

% Approach 2: getTflArgFromString
% arg = getTflArgFromString(hEntry, name, I/O type)
% name- y1..yn | u1..un
% I/O type- RTW_IO_OUTPUT | RTW_IO_INPUT

% Define Output Arguments
arg = getTflArgFromString('y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);

% Define Input Arguments
arg = getTflArgFromString('u1', 'double');
arg.IOType = 'RTW_IO_INPUT';
hEntry.addConceptualArg(arg);

%% Create the implementation representation

% Approach 1: copyConceptualArgsToImplementation
copyConceptualArgsToImplementation(hEntry);

% Approach 2: createAndSetCImplementation, createAndSetCImplementationArg
% arg = createAndAddImplementation(hEntry, argType,varargin),
% arg = createAndSetCImplementationReturn(hEntry, argType,varargin)
% argType - 'RTW.TflArgNumeric' | 'RTW.TflArgMatrix'
% varargin - 'name', 'value' pairs shown below set to default values,
% includes name and I/O type

% Define Output Arguments
hEntry.createAndSetCImplementationReturn(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'y1', ...
        'IOType',                       'RTW_IO_Output', ...
        'IsSigned',                     true, ...
        'WordLength',                   16, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1.0, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'Value',                        0);
    
% Define Input Arguments
hEntry.createAndAddImplementationArg(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'y1', ...
        'IOType',                       'RTW_IO_Output', ...
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        'IsSigned',                     true, ...
        'WordLength',                   16, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1.0, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'Value',                        0);
 

% Approach 3: getTflArgFromString
% arg = getTflArgFromString(hEntry, name, datatype)
% name- y1..yn | u1..un, datatype - built-in data type

% Define Output arguments
arg = getTflArgFromString(hEntry, 'y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg);

% Define Input arguments
arg = getTflArgFromString(hEntry, 'u1', 'double', 0);
hEntry.Implementation.addArgument(arg);

% Approach 4: getTflDWorkFromString
% arg = getTflDWorkFromString(hEntry, name, datatype)

% Define arguments
arg = getTflDWorkFromString('d1', 'void*');
hEntry.addDWorkArg(arg);

% Approach 5: createCRLEntry
% tableEntry = createCRLEntry(crTable,conceptualSpecification,implementationSpecification)

% Define code replacement conceptual and implementation arguments
hEntry = createCRLEntry(...
        hTable, ...
        'conceptualSpecification', ...
        'implementationSpecification');

%% Add code replacement library entry to table
hTable.addEntry(hEntry);

end
7 Specify build information.

Specify build information for your code replacement library. Build information provides the code
generator with the files necessary to perform function replacement.
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To specify build information:

• Specify your build parameters in the Entry Parameters function you defined in step 4 or with
the specified functions. Specify build information with the following properties:

Parameter Description
Implementation header file

Set properties
ImplementationHeaderFile and
ImplementationHeaderPath.

Name of header file needed for code
replacement.

Implementation source file

Set properties
ImplementationSourceFile and
ImplementationSourcePath.

Name of source file needed for code
replacement.

Additional header files/include paths

For each file, specify the file name and path
in calls to the functions
addAdditionalHeaderFile and
addAdditionalIncludePath.

Name and path of additional header files
needed for code replacement.

Additional source files/paths

For each file, specify the file name and path
in calls to the functions
addAdditionalSourceFile and
addAdditionalSourcePath.

Name and path of additional source files
needed for code replacement.

Additional object files/paths

For each file, specify the file name and path
in calls to the functions
addAdditionalLinkObj and
addAdditionalLinkObjPath.

Name and path of additional object files
needed for code replacement.

Additional link flags

Set the entry property
AdditionalLinkFlags to a cell array of
character vectors or string array
representing the required compile flags.

Flags the linker needs to generate an
executable file for the replacement code.

Additional compile flags

Set the entry property
AdditionalCompileFlags to a cell array
of character vectors or string array
representing the required link flags.

Flags the compiler needs to generate object
code for the replacement code.
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Parameter Description
Copy files to build directory.

Set property GenCallback to
'RTW.copyFileToBuildDir'.

If a match occurs for a table entry, a call to
the function RTW.copyFileToBuildDir
copies required files to the build folder.

If you specify additional header files/include
paths or additional source files/paths and you
copy files, the compiler and utilities such as
packNGo might find duplicate instances of
files.

Flags whether to copy header, source, or
object files, which are required to generate
replacement code, to the build folder before
code generation. If you specify files with
Additional header files/include paths or
Additional source files/ paths and you
copy files, the compiler and utilities such as
packNGo might find duplicate instances of
files.

• If an entry uses header, source, or object files, consider whether to make the files accessible
to the code generator. You can copy files to the build folder or you can specify individual file
names and paths explicitly.

• If you specify additional header files/include paths or source files/paths and you copy files, the
compiler and utilities such as packNGo might find duplicate instances of files (an instance in
the build folder and an instance in the original folder).

• If you choose to copy files to the build folder and you are using the packNGo function to
relocate static and generated code files to another development environment:

• In the call to packNGo, specify the property-value pair 'minimalHeaders' true (the
default). That setting instructs the function to include the minimal header files required to
build the code in the zip file.

• Do not collocate files that you copy with files that you do not copy. If the packNGo function
finds multiple instances of the same file, the function returns an error.

• If you use the programming interface, paths that you specify can include tokens. A token is a
variable defined as a character vector, cell array of character vectors, or string array in the
MATLAB workspace that you enclose with dollar signs ($variable$). The code generator
evaluates and replaces a token with the defined value. For example, consider the path
$myfolder$\folder1, where myfolder is a character vector or string scalar variable
defined in the MATLAB workspace as 'd:\work\source\module1'. The code generator
generates the custom path as d:\work\source\module1\folder1.

8 Validate and save.

Save your code replacement library customization file with the same name as your code
replacement library table on your MATLAB path.

To save and validate your library:

a Save your file. From the MATLAB menu, select File > Save.
b Validate your library by calling it from the MATLAB command line. For example:

>> hTable = code_replacement_library_table()
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See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Develop a Code Replacement Library” on page 67-20
• “What Is Code Replacement Customization?” on page 67-3
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Register Code Replacement Library
Create a code replacement library by defining in a registration file the library name, code
replacement tables, and other information. After you define and register your library it becomes
available to the code generator for code replacement.

Interactively Develop and Load a Registration file
1 In the crtool, select File > Generate registration file.

2 In the Generate registration file dialog box, specify registration information. Then click OK.

Parameter Description
Registry name (Required) Code replacement library name.
Table list (Required) Comma-separated list of one or more code

replacement tables that you want in the
library. Specify tables by using either their
names (if located on the MATLAB search
path), absolute paths, or relative paths.

Base CRL Enables you to specify library hierarchies.
Provide the name of a registered library to
serve as a base for the library that you are
currently registering. For example, a TI
device library can be a base for a TI C28x
library.

Target HW device Comma-separated list of one or more
hardware devices that this library supports.
Indicate support of all devices with an
asterisk (*).

Description Description of the purpose and content of the
library.

Generate data alignment specification Flag that enables data alignment.
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3 To use your registered code replacement library, refresh your current MATLAB session with the
command:

>> sl_refresh_customizations

Programmatically Develop and Load a Registration File
1 Open a MATLAB function file. From the MATLAB menu, select New > Function.
2 Save the function file with the name rtwTargetInfo.m.
3 Copy and paste the following code into your file to use as a template.

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; %instantiates a registration entry
this(1).Name = 'Example Code Replacement Library';
this(1).TableList = {'example_code_replacement_table.m'};
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'This registers an example library';

end
4 In the template, specify the following registration information:

Parameter Description
Registry name (Required) Code replacement library name.
Table list (Required) Comma-separated list of one or more code

replacement tables that you want in the
library. Specify tables by using either their
names (if located on the MATLAB search
path), absolute paths, or relative paths.

Base CRL Enables you to specify library hierarchies.
Provide the name of a registered library to
serve as a base for the library that you are
currently registering. For example, a TI
device library can be a base for a TI C28x
library.

Target HW device Comma-separated list of one or more
hardware devices that this library supports.
Indicate support of all devices with an
asterisk (*).

Description Description of the purpose and content of the
library.

Generate data alignment specification Flag that enables data alignment.
5 Save the file on your MATLAB path.
6 To use your registered code replacement library, refresh your current MATLAB session with the

command:
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>> sl_refresh_customizations

Examples
Register one code replacement library

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; %instantiates a registration entry
this(1).Name = 'Example Code Replacement Library';
this(1).TableList = {'example_code_replacement_table.m'};
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'This registers an example library';

end

Register multiple code replacement libraries

function rtwTargetInfo(cm)
cm.registerTargetInfo(@loc_register_crl);
end

function thisCRL = loc_register_crl
  % Register a code replacement library for use with model: rtwdemo_crladdsub
  thisCrl(1) = RTW.TflRegistry;
  thisCrl(1).Name = 'Addition & Subtraction Examples';
  thisCrl(1).Description = 'Example of addition/subtraction op replacement';
  thisCrl(1).TableList = {'crl_table_addsub'};
  thisCrl(1).TargetHWDeviceType = {'*'};

  % Register a code replacement library for use with model: rtwdemo_crlmuldiv
  thisCrl(2) = RTW.TflRegistry;
  thisCrl(2).Name = 'Multiplication & Division Examples';
  thisCrl(2).Description = 'Example of mult/div op repl for built-in integers';
  thisCrl(2).TableList = {'c:/work_crl/crl_table_muldiv'};
  thisCrl(2).TargetHWDeviceType = {'*'};

  % Register a code replacement library for use with model: rtwdemo_crlfixpt
  thisCrl(3) = RTW.TflRegistry;
  thisCrl(3).Name = 'Fixed-Point Examples';
  thisCrl(3).Description = 'Example of fixed-point operator replacement';
  thisCrl(3).TableList = {fullfile('$(MATLAB_ROOT)', ...
     'toolbox','rtw','rtwdemos','crl_demo','crl_table_fixpt')};
   thisCrl(3).TargetHWDeviceType = {'*'};

end

Register a code replacement hierarchy
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function thisCRL = loc_register_crl 
  % Register a code replacement library that includes common entries
  thisCrl(1) = RTW.TflRegistry;
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  thisCrl(1).Name = 'Common Replacements';
  thisCrl(1).Description = 'Common code replacement entries shared by other libraries';
  thisCrl(1).TableList = {'crl_table_general'};
  thisCrl(1).TargetHWDeviceType = {'*'};
 
  % Register a code replacement library for TI devices
  thisCrl(2) = RTW.TflRegistry;
  thisCrl(2).Name = 'TI Device Replacements';
  thisCrl(2).Description = 'Code replacement entries shared across TI devices';
  thisCrl(2).TableList = {'crl_table_TI_devices'};
  thisCrl(2).TargetHWDeviceType = {'TI C28x', 'TI C55x', 'TI C62x', 'TI C64x', 'TI 67x'};
  thisCrl(1).BaseTfl = 'Common Replacements'
 
  % Register a code replacement library for TI c6xx devices
  thisCrl(3) = RTW.TflRegistry;
  thisCrl(3).Name = 'TI c6xx Device Replacements';
  thisCrl(3).Description = 'Code replacement entries shared across TI C6xx devices';
  thisCrl(3).TableList = {'crl_table_TIC6xx_devices'};
  thisCrl(3).TargetHWDeviceType = {'TI C62x', 'TI C64x', 'TI 67x'};
 
  % Register a code replacement library for the TI c67x device
  thisCrl(4) = RTW.TflRegistry;
  thisCrl(4).Name = 'TI c67x Device Replacements';
  thisCrl(4).Description = 'Code replacement entries for the TI C67x device';
  thisCrl(4).TableList = {'crl_table_TIC67x_device'};
  thisCrl(4).TargetHWDeviceType = {'TI 67x'};

 
end

See Also

More About
• “Troubleshoot Code Replacement Library Registration” on page 67-58
• “Develop a Code Replacement Library” on page 67-20
• “What Is Code Replacement Customization?” on page 67-3
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Verify Code Replacement Library
Verify your code replacement library by examining its structure, replacement, and performance. Use
the Code Replacement Viewer (crviewer) to verify the structure of your library. Use the code
replacement report to verify the replacements made with your library in generated code. Use
crviewer again to verify the performance of your library during code generation by examining the
replacement hit and miss logs.

Verify Library Structure
Use the Code Replacement Viewer (crviewer) to open and view the structure of your code
replacement library by examining its tables and table entries.

1 From the MATLAB command prompt, open your code replacement library using the crviewer
with the command:

>> crviewer('library')
2 The viewer opens your code replacement library and shows its code replacement tables in the

left pane. Verify that your library lists all required tables in the correct relative order.
3 Open and view the entries for each code replacement table. In the crtool, click each table listed

in the left pane to view its entries in the middle pane.

If you are not using the crviewer, you can open each table directly from the MATLAB command
prompt with the command:

crviewer(table)
4 For each table in your library, verify that it lists all required entries in the correct relative order.

Verify that the conceptual representation and implementation representation are correct for each
entry in the table.

Verify Library Replacement
Use the Code Replacements Report to verify that when the code generator uses your code
replacement library it creates replacements as expected in the generated code. For each instance of
replacement, the Code Replacements Report provides a mapping between the Simulink block that
triggered the replacement and its implementation in the generated code. Use this mapping to verify
correct code replacement by tracing between the report and the code in either direction (from report
to code or code to report).

To generate the Code Replacements Report:

1 Configure your model to use your code replacement library.
2 Configure your model to open the Code Generation Report. The Code Replacements Report is a

tab within this report. In the Model Configuration Parameters dialog box, in the Code
Generation > Report pane, select:

• Create code generation report
• Open report automatically
• Model-to-code
• Summarize which block triggered code replacements
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3 Configure the generated code to include comments. In the Model Configuration Parameters
dialog box, in the Code Generation > Comments pane, select:

• Include comments
• Either or both of Simulink block comments and Simulink block descriptions

4 Build your model to generate code only. The Code Generation Report opens automatically. On the
left pane, click to open the Code Replacements Report.

5 Verify that code replacements occur as expected.

• Navigate from report to model: In the Code Replacements Report, click each block link to
see the source that triggered replacement.

• Navigate from model to report: In the Simulink model window, use model-to-code
highlighting to trace code replacements. Right-click blocks where you expected code
replacement to occur and select C/C++ Code > Navigate to C/C++ Code. The report
appears with the corresponding replacement code highlighted.

Verify Library Performance
Verify the performance of your code replacement library by examining the hits and misses that
occurred during code generation using your library. During code generation, when the code
generator finds a match for code replacement from your code replacement library, it logs the hit in a
hit cache. When it does not find a code replacement match, it logs the failed attempt in the miss
cache. Each time that you generate code, the code generator overwrites its previous hit and miss
cache logs.

To review trace information from the hit and miss cache data, use the Code Replacement Viewer
(crviewer). From the hit cache, you can identify when code replacement successfully occurred, and
from the miss cache, you can troubleshoot when code replacement did not take place. The miss cache
trace information provides you information about the reason for the miss, a link to the relevant
source location for the miss, and the call site object of the miss. For more information, see
“Troubleshoot Code Replacement Misses” on page 67-59.

See Also

More About
• “Troubleshoot Code Replacement Misses” on page 67-59
• “Register Code Replacement Library” on page 67-51
• “Deploy Code Replacement Library” on page 67-57
• “What Is Code Replacement Customization?” on page 67-3
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Deploy Code Replacement Library
Package and deploy your code replacement library.

1 Move your code replacement library customization and registration files to a location on the
MATLAB® search path that is accessible to other users. If another registration file already exists
in that location, copy and paste the information for your code replacement library into the
existing registration file.

2 Refresh your session and verify that the library is available as a configuration option for the code
generator.

3 Verify that code replacement occurs as expected in generated code.
4 Inform users that the code replacement library is available.

See Also

More About
• “Relocate Code to Another Development Environment”
• “Develop a Code Replacement Library” on page 67-20
• “What Is Code Replacement Customization?” on page 67-3
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Troubleshoot Code Replacement Library Registration
If a code replacement library is not listed as a configuration option or does not appear in the Code
Replacement Viewer:

• Refresh the library registration information within the current MATLAB session
(RTW.TargetRegistry.getInstance('reset'); or for the Simulink
environment,sl_refresh_customizations).

• See whether the registration file, rtwTargetInfo.m, contains an error.

See Also

More About
• “Register Code Replacement Library” on page 67-51
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Troubleshoot Code Replacement Misses
Use miss reason messages that appear in the Code Replacement Viewer to analyze and correct
code replacement misses.

Miss Reason Messages
The Code Replacement Viewer displays miss reason messages in trace information for code
replacement misses. A legend listing each message that appears in the miss report precedes the
report details. A message consists of:

• Numeric identifier, which identifies the message in the report details.
• Message text, which in some cases includes placeholders for names of arguments, call site object

values, table entry values, and property names.

For example:

1. Mismatched data types (argument name, CSO value, table entry value)

The parenthetical information represents placeholders for actual values that appear in the report
details.

In the Miss Source Locations table that lists the miss details, the Reason column includes:

• The message identifier, as listed in the legend.
• The placeholder values for that instance of the miss reason message.

The following Reason details indicate a data type mismatch because the call site object specifies data
type int8 for arguments y1, u1, and u2, while the code replacement table entry specifies uint32.

1. y1, int8, uint32
   u1, int8, uint32
   u2, int8, uint32

Depending on your situation and the reported miss reason, troubleshoot reported misses by looking
for instances of the following:

• A typo in the code replacement table entry definition or a source parameter setting.
• Information missing from the code replacement table entry or a source parameter setting.
• Invalid or incorrect information in the code replacement table entry definition or a source

parameter setting.
• Arguments incorrectly ordered in the code replacement table entry definition or the source being

replaced with replacement code.
• Failed algorithm classification for an addition or subtraction operation due to:

• An ideal accumulator not being calculated because the type of an input argument is not fixed-
point or the slope adjustment factors of the input arguments are not equal.

• Input or output casts with a floating-point cast type.
• Input or output casts with cast types that have different slope adjustment factors or biases.
• Output casts not being convertible to a single output cast.
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• Input casts resulting in loss of bits.

Analyze and Correct Code Replacement Misses
The following example shows how to use Code Replacement Viewer trace information to troubleshoot
code replacement misses. You must have already reviewed and tested code replacements for your
model.

1 Review the code generated for a model element, looking for expected code replacements. For
this example, examine the code generated for block Sub32 in model rtwdemo_crladdsub.
Right-click the block and select C/C++ Code > Navigate to C/C++ Code.

The Code Generation Report opens to the location of the generated code for that block.

The code generator replaced code, but the replacement was for the signed version of the 32-bit
subtraction operation. You expected an unsigned operation.

2 Regenerate or reopen the Code Replacements Report for your model. If you already generated
the code generation report that includes the Code Replacements Report for model
rtwdemo_crladdsub, open the file rtwdemo_crladdsub_ert_rtw/html/
rtwdemo_crladdsub_codegen_rpt.html. For information on how to regenerate the report,
see “Verify Code Replacement Library” on page 67-55.

3 Click the link to open the Code Replacement Viewer.
4 In the viewer left pane, select your code replacement table. The following display shows entries

for code replacement table crl_table_addsub.
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5 In the middle pane, select table entry RTW_OP_MINUS with implementation function
u32_sub_u32_u32.

6 In the right pane, select the Trace Information tab.

The Trace Information is a table that lists the following information for each miss:

• Call site object preview. The call site object is the conceptual representation of a subtraction
operator. The code generator uses this object to query the code replacement library for a
match.

• A link to the source location in the model for which the code generator considered replacing
code.

• The reasons that the miss occurred. For the list of reasons that misses occur, see “Miss
Reason Messages” on page 67-59.

For this example, the report shows misses for two blocks: Sub32 and Sub8.
7 Find that source in the trace information. Depending on your situation and the reported miss

reason, consider looking for a condition such as a typo in the code replacement table entry
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definition or in a source parameter setting. “Miss Reason Messages” on page 67-59 lists
conditions to consider.

For this example, determine why code for the Sub32 block was not replaced with code for an
unsigned 32-bit subtraction operation. The miss reason for the Sub32 block indicates a data type
mismatch. The data type in the call site object for the three arguments is a signed 32-bit integer.
The code replacement entry specifies an unsigned 32-bit integer.

8 Correct the model or code replacement table entry. If the issue is in the model, use the source
location link in the trace information to find the model element to correct. For this example, you
expected an unsigned subtraction operation for the Sub32 block. Click the link in the trace report
for the Sub32 block.

The model opens with the Sub32 block highlighted.

Change the data type setting for the two input signals and the output signal for the Sub32 block
to uint32.

9 Regenerate code. Use the Code Replacement Viewer trace information to verify that your model
or code replacement table entry corrects the code replacement issue. In the following display, the
trace information shows a hit for block Sub32.
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See Also

More About
• “Verify Code Replacement Library” on page 67-55
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Math Function Code Replacement
This example shows how to develop a code replacement library to optimize the performance of math
functions by providing information on how to define code replacement for a sin function. To develop
a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_sin. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select sin. Algorithm information

appears in the crtool. For this example, leave the parameter unspecified.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1, with the Data Type of double and
the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

7 Specify build information. Click the Build Information tab to open the build requirements pane.
Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_sin
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_table_sin
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = rtw.TflCFunctionEntry;
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4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_sin()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'sin', ...
        'Priority',                    30, ...
        'ImplementationName',          'mySin', ...
        'ImplementationHeaderFile',    'basicMath.h', ...
        'ImplementationSourceFile',    'basicMath.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_table_sin()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'sin', ...
        'Priority',                    30, ...
        'ImplementationName',          'mySin', ...
        'ImplementationHeaderFile',    'basicMath.h', ...
        'ImplementationSourceFile',    'basicMath.c');

%% Create the conceptual representation
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'y1',...
        'IOType',                 'RTW_IO_OUTPUT',...
        'DataTypeMode',           'double');

hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'u1', ...
        'IOType',                 'RTW_IO_INPUT',...
        'DataTypeMode',           'double');

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
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function hTable = crl_table_sin()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'sin', ...
        'Priority',                    30, ...
        'ImplementationName',          'mySin', ...
        'ImplementationHeaderFile',    'basicMath.h', ...
        'ImplementationSourceFile',    'basicMath.c');

%% Create the conceptual representation
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'y1',...
        'IOType',                 'RTW_IO_OUTPUT',...
        'DataTypeMode',           'double');

hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'u1', ...
        'IOType',                 'RTW_IO_INPUT',...
        'DataTypeMode',           'double');

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_sin

9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for sin function replacement’;
this(1).TableList = {'crl_table_sin.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';
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end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Generate Code by Using Math Code Replacement Library
In this section, you generate code using the code replacement library that you created in the first two
sections of this example. A math function sin is replaced with a call to a custom function in the
generated code. This example does not provide an implementation function. Write your own
implementation.

Example Model

Open the model crl_mathfunction for configuring the code replacement library.

open_system('crl_mathfunction');

copyfile mathFnRtwTargetInfo.txt rtwTargetInfo.m

Run the MATLAB customization file to create a code replacement table and register the file. The
customization file has already been executed. Run the sl_refresh_customizations function to register
the library.

sl_refresh_customizations;

Enable Code Replacement Library

1 Open the Configuration Parameters dialog box.
2 On the Interface pane, set Code Replacement Library by clicking Select and adding CRL for

sin function replacement to the Selected code replacement libraries - prioritized list
pane. Alternatively, use the command-line API to enable the code replacement:

set_param('crl_mathfunction', 'CodeReplacementLibrary', 'CRL for sin function replacement');

Generate code from the model:

evalc('rtwbuild(''crl_mathfunction'')');

View the generated code. Here is a portion of crl_mathfunction.c.

cfile = fullfile('crl_mathfunction_ert_rtw','crl_mathfunction.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);
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/* Model step function */
void crl_mathfunction_step(void)
{
  /* Outport: '<Root>/Y1' incorporates:
   *  Inport: '<Root>/U1'
   *  Trigonometry: '<Root>/Trigonometric Function'
   */
  crl_mathfunction_Y.Y1 = mySin(crl_mathfunction_U.U1);
}

The sin function is replaced with a custom mysin function.

Close the model and code generation report.

delete ./rtwTargetInfo.m
bdclose('crl_mathfunction');
rtwdemoclean;

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Algorithm-Based Code Replacement” on page 67-81
• “Develop a Code Replacement Library” on page 67-20
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Memory Function Code Replacement
This example shows how to develop a code replacement library to optimize the performance of
memory functions by providing information on how to define code replacement for a memcpy
function. To develop a code replacement library use either the interactive or programmatic approach.
For more information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_memcpy. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select memcpy.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of void and the Argument Type of Pointer,
the input arguments, u1 and u2 with the Data Type of void and the Argument Type of Pointer
and u3 with the Data Type of unsigned integral and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
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10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_memcpy()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = rtw.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
% Set SideEffects to 'true' for function returning void to prevent it from 
% being optimized away.
hEntry.setTflCFunctionEntryParameters(...
                               'Key',                      'memcpy', ...
                               'Priority',                 90, ...
                               'ImplementationName',       'memcpy_int', ...
                               'ImplementationHeaderFile', 'memcpy_int.h',...
                               'SideEffects',              true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

 Memory Function Code Replacement

67-73



function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
% Set SideEffects to 'true' for function returning void to prevent it from 
% being optimized away.
hEntry.setTflCFunctionEntryParameters(...
                               'Key',                      'memcpy', ...
                               'Priority',                 90, ...
                               'ImplementationName',       'memcpy_int', ...
                               'ImplementationHeaderFile', 'memcpy_int.h',...
                               'SideEffects',              true);

%% Create conceptual arguments
arg = getTflArgFromString(hTable, 'y1', 'void*');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u2', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u3', 'size_t');
addConceptualArg(hEntry, arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
                               'Key',                      'memcpy', ...
                               'Priority',                 90, ...
                               'ImplementationName',       'memcpy_int', ...
                               'ImplementationHeaderFile', 'memcpy_int.h',...
                               'SideEffects',              true);

%% Create conceptual arguments
arg = getTflArgFromString(hTable, 'y1', 'void*');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u2', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u3', 'size_t');
addConceptualArg(hEntry, arg);
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%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_memcpy
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for memory function replacement’;
this(1).TableList = {'crl_table_memcpy.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Math Function Code Replacement” on page 67-64
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Nonfinite Function Code Replacement
This example shows how to develop a code replacement library to optimize the performance of
nonfinite functions by providing information on how to define code replacement for a sqrt function.
To develop a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_nonfinite. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as getNaN .
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of double and the Argument Type of scalar
and the input argument, u1, with the Data Type of void and the Argument Type of scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, set the Implementation header file to nonfin.h.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_nonfinite()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.
function hTable = crl_table_nonfinite()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry  = rtw.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_nonfinite()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry  = RTW.TflCFunctionEntry;

%% Create entry parameters 
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'getNaN', ...
        'Priority',                    30, ...
        'ImplementationName',          'mygetNaN', ...
        'ImplementationHeaderFile',    'getInf.h', ...
        'ImplementationSourceFile',    'getInf.c');
    

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.
function hTable = crl_table_nonfinite()
% Create a code replacement library table 
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%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry  = RTW.TflCFunctionEntry;

%% Create entry parameters 
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'getNaN', ...
        'Priority',                    30, ...
        'ImplementationName',          'mygetNaN', ...
        'ImplementationHeaderFile',    'getInf.h', ...
        'ImplementationSourceFile',    'getInf.c');

%% Create the conceptual representation
  arg = getTflArgFromString(hTable, 'y1', 'double');
  arg.IOType = 'RTW_IO_OUTPUT';
  addConceptualArg(hEntry, arg);

  arg = getTflArgFromString(hTable, 'u1', 'void');
  addConceptualArg(hEntry, arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTable = crl_table_nonfinite()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry  = RTW.TflCFunctionEntry;

%% Create entry parameters 
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'getNaN', ...
        'Priority',                    30, ...
        'ImplementationName',          'mygetNaN', ...
        'ImplementationHeaderFile',    'getInf.h', ...
        'ImplementationSourceFile',    'getInf.c');

%% Create the conceptual representation
  arg = getTflArgFromString(hTable, 'y1', 'double');
  arg.IOType = 'RTW_IO_OUTPUT';
  addConceptualArg(hEntry, arg);

  arg = getTflArgFromString(hTable, 'u1', 'void');
  addConceptualArg(hEntry, arg);

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
addEntry(hTable, hEntry);
  

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_nonfinite
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
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end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for nonfinite function replacement’;
this(1).TableList = {'crl_table_nonfinite.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Math Function Code Replacement” on page 67-64
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Algorithm-Based Code Replacement
You can develop a code replacement library to optimize the performance of certain math functions
based on the computation or approximation algorithm configured for a block.

For example, you can configure:

• The Reciprocal Sqrt block to use the Newton-Raphson or Exact computation method.
• The Trigonometric Function block, with Function set to sin, cos, or sincos, to use the

approximation method CORDIC or None.

To develop a code replacement library, use either the interactive or programmatic approach. For
more information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_rsqrt. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select rSqrt. Algorithm information

appears in the crtool. For this example, set the parameter to Newton Raphson.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1, by using the Data Type of double
and the Argument Type of Scalar.

Specify a Name for the replacement function under Function prototype.
6 Create the implementation representation. The implementation representation describes the

signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

7 Specify build information. Click the Build Information tab to open the build requirements pane.
Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
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10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function cannot have
arguments or return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_rsqrt()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_rsqrt()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

To use the algorithm for a function in an entry definition, set the EntryInfoAlgorithm
property in a call to the function setTflCFunctionEntryParameters as
RTW_Newton_Raphson.

function hTable = crl_rsqrt()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
  'Key',                      'rSqrt', ...
  'Priority',                 80, ...
  'ImplementationName',       'rsqrt_newton', ...
  'ImplementationHeaderFile', 'rsqrt.h', ...
  'EntryInfoAlgorithm',       'RTW_NEWTON_RAPHSON');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_rsqrt()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
  'Key',                      'rSqrt', ...
  'Priority',                 80, ...
  'ImplementationName',       'rsqrt_newton', ...
  'ImplementationHeaderFile', 'rsqrt.h', ...
  'EntryInfoAlgorithm',       'RTW_NEWTON_RAPHSON');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
  'Name',         'y1', ...
  'IOType',       'RTW_IO_OUTPUT', ...
  'DataTypeMode', 'double');

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
  'Name',         'u1', ...
  'DataTypeMode', 'double');

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.

function hTable = crl_rsqrt()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
  'Key',                      'rSqrt', ...
  'Priority',                 80, ...
  'ImplementationName',       'rsqrt_newton', ...
  'ImplementationHeaderFile', 'rsqrt.h', ...
  'EntryInfoAlgorithm',       'RTW_NEWTON_RAPHSON');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
  'Name',         'y1', ...
  'IOType',       'RTW_IO_OUTPUT', ...
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  'DataTypeMode', 'double');

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
  'Name',         'u1', ...
  'DataTypeMode', 'double');

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_rsqrt

9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:

function rtwTargetInfo(cm)
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl  
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for algorithm function replacement';
this(1).TableList = {'crl_rsqrt.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';
end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations

10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Math Function Code Replacement” on page 67-64
• “Develop a Code Replacement Library” on page 67-20
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• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”
on page 72-27
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Lookup Table Function Code Replacement
You can configure the algorithm for table lookup operations and index searches and generate code. If
the code generated for available algorithm options does not meet requirements for your application,
create custom code replacement table entries to replace the generated algorithm code. You can
develop a code replacement library to optimize the performance of algorithms in a lookup table block.
For more information, see “Develop a Code Replacement Library” on page 67-20. For more
information about using lookup table blocks, see “Nonlinearity”.

Lookup Table Function Signatures
To create code replacement table entries for a function corresponding to a lookup table algorithm,
you must have:

• Information about the conceptual function signature.
• Relevant algorithm parameters.

This table provides the conceptual function signature information.

Conceptual Function Signature Argument Summary
y1 = interp1D(u1, u2, u3, u4) y1 – output

u1 – index
u2 – fraction
u3 – table data
u4 – table dimension length

y1 = interp2D(u1, u2, u3, u4, u5, u6, u7) y1 – output
u1, u3 – index
u2, u4 – fraction
u5 – table data
u6, u7 – table dimension lengths

y1 = interp3D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10)

y1 – output
u1, u3, u5 – index
u2, u4, u6 – fraction
u7 – table data
u8, u9, u10 – table dimension lengths

y1 = interp4D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13)

y1 – output
u1, u3, u5, u7 – index
u2, u4, u6, u8 – fraction
u9 – table data
u10, u11, u12, u13 – table dimension
lengths

y1 = interp5D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13, u14, u15, u16)

y1 – output
u1, u3, u5, u7, u9 – index
u2, u4, u6, u8, u10 – fraction
u11 – table data
u12, u13, u14, u15, u16 – table
dimension lengths
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Conceptual Function Signature Argument Summary
y1 = interpND({ui, uf,}... ut, un...) y1 – output

ui, uf is an index and fraction pair per
dimension
ut – table data
un – table dimension lengths

Explicit values
y1 = lookup1D(u1, u2, u3, u4)

y1 – output
u1 – input
u2 – breakpoint data
u3 – table data
u4 – table dimension length

Even spacing
y1 = lookup1D(u1, u2, u3, u4, u5)

y1 – output
u1 – input
u2 – first point of breakpoint data
u3 – spacing of breakpoints
u4 – table data
u5 – table dimension length

Explicit values
y1 = lookup2D(u1, u2, u3, u4, u5, u6, u7)

y1 – output
u1, u2 – input
u3, u4 – breakpoint data
u5 – table data
u6, u7 – table dimension lengths

Even spacing
y1 = lookup2D(u1, u2, u3, u4, u5, u6, u7, u8, u9)

y1 – output
u1, u2 – input
u3, u5 – first point of breakpoint data
u4, u6 – spacing of breakpoints
u7 – table data
u8, u9 – table dimension lengths

Explicit spacing
y1 = lookup3D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10)

y1 – output
u1, u2, u3 – input
u4, u5, u6 – breakpoint data
u7 – table data
u8, u9, u10 – table dimension lengths

Even spacing
y1 = lookup3D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13)

y1 – output
u1, u2, u3 – input
u4, u6, u8 – first point of breakpoint
data
u5, u7, u9 – spacing of breakpoints
u10 – table data
u11, u12, u13 – table dimension
lengths

Explicit values
y1 = lookup4D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13)

y1 – output
u1, u2, u3, u4 – input
u5, u6, u7, u8 – breakpoint data
u9 – table data
u10, u11, u12, u13 – table dimension
lengths
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Conceptual Function Signature Argument Summary
Even spacing
y1 = lookup4D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13, u14, u15, u16, u17)

y1 – output
u1, u2, u3, u4 – input
u5, u7, u9, u11 – first point of
breakpoint data
u6, u8, u10, u12 – spacing of
breakpoints
u13 – table data
u14, u15, u16, u17 – table dimension
lengths

Explicit values
y1 = lookup5D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13, u14, u15, u16)

y1 – output
u1, u2, u3, u4, u5 – input
u6, u7, u8, u9, u10 – breakpoint
data
u11 – table data
u12, u13, u14, u15, u16 – table
dimension lengths

Even spacing
y1 = lookup5D(u1, u2, u3, u4, u5, u6, u7, u8, u9,
u10, u11, u12, u13, u14, u15, u16, u17, u18, u19,
u20, u21)

y1 – output
u1, u2, u3, u4, u5 – input
u6, u8, u10, u12, u14 – first point of
breakpoint data
u7, u9, u11, u13, u15 – spacing of
breakpoints
u16 – table data
u17, u18, u19, u20, u21 – table
dimension lengths

Explicit values
y1 = lookupND(un,..., ub,..., ut, un...)

y1 – output
un, input per dimension
ub, breakpoint per dimension
ut – table data
un – table dimension lengths

Even spacing
y1 = lookupND(un,..., {ufn, usn,}... ut, un...)

y1 – output
un – input per dimension
ufn – first point of breakpoint data per
dimension
usn – spacing of breakpoint per dimension
ut – table data
un – table dimension lengths

y1 = lookupND_Direct(u1, u2,...ui, ui+1) y1 – output
u1...ui – input
ui+1 – table data

Explicit values
y1, y2 = prelookup(u1, u2, u3)

y1 – index
y2 – fraction
u1 – input
u2 – breakpoint data
u3 – number of breakpoints
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Conceptual Function Signature Argument Summary
Evenly spaced
y1, y2 = prelookup(u1, u2, u3, u4)

y1 – index
y2 – fraction
u1 – input
u2 – first point of breakpoint data
u3 – spacing of breakpoints
u4 – number of breakpoints

When defining a table entry programmatically, you might also need to change the values of required
(primary) and optional algorithm parameters.

• Set values for required parameters to achieve code replacement.
• If you do not set a value for an optional parameter, the algorithm parameter software applies

don't care. The code replacement software ignores the parameter while searching for matches.

Interactively Develop a Code Replacement Library
This example shows how to specify a code replacement table entry for a lookup table algorithm
interp1D by using the Code Replacement Tool.

1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following
command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_LUT. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as lookup1D . Set the algorithm
parameters as shown in the crtool snapshot below.

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument u1 with the Data Type of double and
u4 , with the Data Type of uint32 and the Argument Type of Scalar.

Specify the Argument Type of input arguments u2 and u3 as Matrixand Data Type as double.
Set the Algorithm parameters as shown in the figure below.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Add the return argument y1 and the arguments u1, u2, u3 and u4.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.
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8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.

9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:
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>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programatically develop a code replacement library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = my_lookup_replacement_table
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = my_lookup_replacement_table
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = my_lookup_replacement_table()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
          'Key',                      'lookup1D', ...
          'Priority',                 100, ...
          'ImplementationName',       'my_Lookup1D_Repl', ...
          'ImplementationHeaderFile', 'myLookup1D.h', ...
          'ImplementationSourceFile', 'myLookup1D.c', ...
          'GenCallback',              'RTW.copyFileToBuildDir');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = my_lookup_replacement_table()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
          'Key',                      'lookup1D', ...
          'Priority',                 100, ...
          'ImplementationName',       'my_Lookup1D_Repl', ...
          'ImplementationHeaderFile', 'myLookup1D.h', ...
          'ImplementationSourceFile', 'myLookup1D.c', ...
          'GenCallback',              'RTW.copyFileToBuildDir');

%% Create the conceptual representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = hEntry.getTflArgFromString('u1','double');
addConceptualArg(hEntry, arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'double');
arg.DimRange = [0 0; Inf Inf];
addConceptualArg(hEntry, arg);

arg = RTW.TflArgMatrix('u3', 'RTW_IO_INPUT',  'double');
arg.DimRange = [0 0; Inf Inf];
addConceptualArg(hEntry, arg);

arg = hEntry.getTflArgFromString('u4','uint32');
addConceptualArg(hEntry, arg);
      

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.
function hTable = my_lookup_replacement_table()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
          'Key',                      'lookup1D', ...
          'Priority',                 100, ...
          'ImplementationName',       'my_Lookup1D_Repl', ...
          'ImplementationHeaderFile', 'myLookup1D.h', ...
          'ImplementationSourceFile', 'myLookup1D.c', ...
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          'GenCallback',              'RTW.copyFileToBuildDir');

%% Create the conceptual representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = hEntry.getTflArgFromString('u1','double');
addConceptualArg(hEntry, arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'double');
arg.DimRange = [0 0; Inf Inf];
addConceptualArg(hEntry, arg);

arg = RTW.TflArgMatrix('u3', 'RTW_IO_INPUT',  'double');
arg.DimRange = [0 0; Inf Inf];
addConceptualArg(hEntry, arg);

arg = hEntry.getTflArgFromString('u4','uint32');
addConceptualArg(hEntry, arg);

algParams = getAlgorithmParameters(hEntry);   
algParams.InterpMethod = 'Linear';
algParams.ExtrapMethod = 'Clip';
algParams.UseRowMajorAlgorithm = 'off';
algParams.RndMeth = 'Round';
algParams.IndexSearchMethod = 'Linear search';
algParams.UseLastTableValue = 'off';
algParams.RemoveProtectionInput = 'off';
algParams.SaturateOnIntegerOverflow = 'off';
algParams.SupportTunableTableSize = 'off';
algParams.BPPower2Spacing = 'off';
setAlgorithmParameters(hEntry, algParams);

%% Create the Implementation Representation  
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = hEntry.getTflArgFromString('u1','double');
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u2','double*');
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u3','double*');
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u4','uint32');
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = my_lookup_replacement_table
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for LUT 1D function replacement’;
this(1).TableList = {'my_lookup_replacement_table.m'}; % table created in this example
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this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Generate Code by Using Lookup Table Code Replacement Library
In this section, you generate code using the code replacement library that you created in the first two
sections of this example. A Lookup table function is replaced with a call to a custom function in the
generated code. This example does not provide an implementation function. Write your own
implementation.

Example Model

Open the model crl_LUTfunction for configuring the code replacement library.

open_system('crl_LUTfunction');

copyfile LutFnRtwTargetInfo.txt rtwTargetInfo.m

Run the MATLAB customization file to create a code replacement table and register the file. The
customization file has already been executed. Run the sl_refresh_customizations function to load the
library.

sl_refresh_customizations;

Enable Code Replacement Library

1 Open the Configuration Parameters dialog box.
2 On the Interface pane, set Code Replacement Library by clicking Select and adding CRL for

LUT function replacement to the Selected code replacement libraries - prioritized list
pane.

%
% Alternatively, use the command-line API to enable the code replacement:
set_param('crl_LUTfunction', 'CodeReplacementLibrary', 'CRL for LUT function replacement');

Generate code from the model:

evalc('slbuild(bdroot)');
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View the generated code. Here is a portion of crl_LUTfunction.c.

cfile = fullfile('crl_LUTfunction_ert_rtw','crl_LUTfunction.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void crl_LUTfunction_step(void)
{
  int32_T iU;

  /* Lookup_n-D: '<Root>/1-D Lookup Table2' incorporates:
   *  Constant: '<Root>/Constant2'
   */
  for (iU = 0; iU < 9; iU++) {
    crl_LUTfunction_Y.Y1[iU] = my_Lookup1D_Repl
      (crl_LUTfunction_ConstP.Constant2_Value[iU],
       &crl_LUTfunction_ConstP.uDLookupTable2_bp01Data[0],
       &crl_LUTfunction_ConstP.uDLookupTable2_tableData[0], 10U);
  }

  /* End of Lookup_n-D: '<Root>/1-D Lookup Table2' */
}

The Lookup Table function is replaced with a custom my_Lookup1D_Repl function.

Close the model and code generation report.

delete ./rtwTargetInfo.m
bdclose('crl_LUTfunction');
rtwdemoclean;

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Define Code Replacement Library Optimizations” on page 67-36
• “Data Alignment for Code Replacement” on page 67-97
• “Reserved Identifiers and Code Replacement” on page 67-117
• “Customize Match and Replacement Process” on page 67-118
• “Develop a Code Replacement Library” on page 67-20
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Data Alignment for Code Replacement
Code replacement libraries can align data objects passed into a replacement function to a specified
boundary.

Code Replacement Data Alignment
You can take advantage of function implementations that require aligned data to optimize application
performance. To configure data alignment for a function implementation:

1 Specify the data alignment requirements in a code replacement entry. Specify alignment
separately for each implementation function argument or collectively for all function arguments.
See “Specify Data Alignment Requirements for Function Arguments” on page 67-97.

2 Specify the data alignment capabilities and syntax for one or more compilers. Include the
alignment specifications in a library registration entry in the rtwTargetInfo.m file. See
“Provide Data Alignment Specifications for Compilers” on page 67-98.

3 Register the library containing the table entry and alignment specification object.
4 Configure the code generator to use the code replacement library and generate code. Observe

the results.

For examples, see “Basic Example of Code Replacement Data Alignment” on page 67-101 and the
“Data Alignment for Function Implementations” section of the “Optimize Generated Code By
Developing and Using Code Replacement Libraries - Simulink®” on page 72-27 example page.

Specify Data Alignment Requirements for Function Arguments
To specify the data alignment requirement for an argument in a code replacement entry:

• If you are defining a replacement function in a code replacement table registration file, create an
argument descriptor object (RTW.ArgumentDescriptor). Use its AlignmentBoundary property
to specify the required alignment boundary and assign the object to the argument Descriptor
property.

• If you are defining a replacement function using the Code Replacement Tool, on the Mapping
Information tab, in the Argument properties section for the replacement function, enter a
value for the Alignment value parameter.
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The AlignmentBoundary property (or Alignment value parameter) specifies the alignment
boundary for data passed to a function argument, in number of bytes. The AlignmentBoundary
property is valid only for addressable objects, including matrix and pointer arguments. It is not
applicable for value arguments. Valid values are:

• -1 (default) — If the data is a Simulink.Bus, Simulink.Signal, or Simulink.Parameter
object, specifies that the code generator determines an optimal alignment based on usage.
Otherwise, specifies that there is not an alignment requirement for this argument.

• Positive integer that is a power of 2, not exceeding 128 — Specifies number of bytes in the
boundary. The starting memory address for the data allocated for the function argument is a
multiple of the specified value. If you specify an alignment boundary that is less than the natural
alignment of the argument data type, the alignment directive is emitted in the generated code.
However, the target compiler ignores the directive.

The following code specifies the AlignmentBoundary for an argument as 16 bytes.

hLib = RTW.TflTable;
entry = RTW.TflCOperationEntry;
arg = getTflArgFromString(hLib, 'u1','single*');
desc = RTW.ArgumentDescriptor;
desc.AlignmentBoundary = 16;
arg.Descriptor = desc;
entry.Implementation.addArgument(arg);

The equivalent alignment boundary specification in the Code Replacement Tool dialog box is in this
figure.

Note If your model imports Simulink.Bus, Simulink.Parameter, or Simulink.Signal objects,
specify an alignment boundary in the object properties, using the Alignment property. For more
information, see Simulink.Bus, Simulink.Parameter, and Simulink.Signal.

Provide Data Alignment Specifications for Compilers
To support data alignment in generated code, describe the data alignment capabilities and syntax for
your compilers in the code replacement library registration. Provide one or more alignment
specifications for each compiler in a library registry entry.

To describe the data alignment capabilities and syntax for a compiler:

• If you are defining a code replacement library registration entry in a rtwTargetInfo.m
customization file, add one or more AlignmentSpecification objects to an
RTW.DataAlignment object. Attach the RTW.DataAlignment object to the
TargetCharacteristics object of the registry entry.
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The RTW.DataAlignment object also has the property DefaultMallocAlignment, which
specifies the default alignment boundary, in bytes, that the compiler uses for dynamically allocated
memory. If the code generator uses dynamic memory allocation for a data object involved in a
code replacement, this value determines if the memory satisfies the alignment requirement of the
replacement. If not, the code generator does not use the replacement. The default value for
DefaultMallocAlignment is -1, indicating that the default alignment boundary used for
dynamically allocated memory is unknown. In this case, the code generator uses the natural
alignment of the data type to determine whether to allow a replacement.

Additionally, you can specify the alignment boundary for complex types by using the
addComplexTypeAlignment function.

• If you are generating a customization file function using the Code Replacement Tool, fill out the
following fields for each compiler.

Click the plus (+) symbol to add additional compiler specifications.

For each data alignment specification, provide the following information.
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Alignment‐
Specification
Property

Dialog Box
Parameter

Description

AlignmentType Alignment type Cell array of predefined enumerated strings, specifying which
types of alignment this specification supports.

• DATA_ALIGNMENT_LOCAL_VAR — Local variables.
• DATA_ALIGNMENT_GLOBAL_VAR — Global variables.
• DATA_ALIGNMENT_STRUCT_FIELD — Individual structure
fields.

• DATA_ALIGNMENT_WHOLE_STRUCT — Whole structure, with
padding (individual structure field alignment, if specified, is
favored and takes precedence over whole structure
alignment).

Each alignment specification must specify at least
DATA_ALIGNMENT_GLOBAL_VAR and
DATA_ALIGNMENT_STRUCT_FIELD.

AlignmentPosition Alignment
position

Predefined enumerated string specifying the position in which you
must place the compiler alignment directive for alignment type
DATA_ALIGNMENT_WHOLE_STRUCT:

• DATA_ALIGNMENT_PREDIRECTIVE — The alignment directive
is emitted before struct st_tag{…}, as part of the type
definition statement (for example, MSVC).

• DATA_ALIGNMENT_POSTDIRECTIVE — The alignment
directive is emitted after struct st_tag{…}, as part of the
type definition statement (for example, gcc).

• DATA_ALIGNMENT_PRECEDING_STATEMENT — The alignment
directive is emitted as a standalone statement immediately
preceding the definition of the structure type. A semicolon (;)
must terminate the registered alignment syntax.

• DATA_ALIGNMENT_FOLLOWING_STATEMENT — The alignment
directive is emitted as a standalone statement immediately
following the definition of the structure type. A semicolon (;)
must terminate the registered alignment syntax.

For alignment types other than
DATA_ALIGNMENT_WHOLE_STRUCT, code generation uses
alignment position DATA_ALIGNMENT_PREDIRECTIVE.
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Alignment‐
Specification
Property

Dialog Box
Parameter

Description

AlignmentSyntax‐
Template

Alignment
syntax

Specifies the alignment directive string that the compiler
supports. The string is registered as a syntax template that has
placeholders in it. These placeholders are supported:

• %n — Replaced by the alignment boundary for the replacement
function argument.

• %s — Replaced by the aligned symbol, usually the identifier of
a variable.

For example, for the gcc compiler, you can specify
__attribute__((aligned(%n))), or for the MSVC compiler,
__declspec(align(%n)).

SupportedLanguages Supported
languages

Cell array specifying the languages to which this alignment
specification applies, among c and c++. Sometimes alignment
syntax and position differ between languages for a compiler.

Here is a data alignment specification for the GCC compiler:
da = RTW.DataAlignment;

as = RTW.AlignmentSpecification;
as.AlignmentType = {'DATA_ALIGNMENT_LOCAL_VAR', ...
                    'DATA_ALIGNMENT_STRUCT_FIELD', ...
                    'DATA_ALIGNMENT_GLOBAL_VAR'};
as.AlignmentSyntaxTemplate = '__attribute__((aligned(%n)))';
as.AlignmentPosition = 'DATA_ALIGNMENT_PREDIRECTIVE';
as.SupportedLanguages = {'c', 'c++'};
da.addAlignmentSpecification(as);

tc = RTW.TargetCharacteristics;
tc.DataAlignment = da;

Here is the corresponding specification in the Generate customization dialog box of the Code
Replacement Tool.

Basic Example of Code Replacement Data Alignment
A simple example of the complete workflow for data alignment specified for code replacement is:
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1 Create and save the following code replacement table definition file,
crl_table_mmul_4x4_single_align.m. This table defines a replacement entry for the *
(multiplication) operator, the single data type, and input dimensions [4,4]. The entry also
specifies a data alignment boundary of 16 bytes for each replacement function argument. The
entry expresses the requirement that the starting memory address for the data allocated for the
function arguments during code generation is a multiple of 16.

function hLib = crl_table_mmul_4x4_single_align
%CRL_TABLE_MMUL_4x4_SINGLE_ALIGN - Describe matrix operator entry with data alignment

hLib = RTW.TflTable;
entry = RTW.TflCOperationEntry;
setTflCOperationEntryParameters(entry, ...
    'Key',                   'RTW_OP_MUL', ...
    'Priority',              90, ...
    'ImplementationName',    'matrix_mul_4x4_s');

% conceptual arguments
createAndAddConceptualArg(entry, 'RTW.TflArgMatrix',...
                                'Name',         'y1', ...
                                'IOType',       'RTW_IO_OUTPUT', ...
                                'BaseType',     'single', ...
                                'DimRange',     [4 4]);

createAndAddConceptualArg(entry, 'RTW.TflArgMatrix',...
                                'Name',         'u1', ...
                                'BaseType',     'single', ...
                                'DimRange',     [4 4]);

createAndAddConceptualArg(entry, 'RTW.TflArgMatrix',...
                                'Name',         'u2', ...
                                'BaseType',     'single', ...
                                'DimRange',     [4 4]);

% implementation arguments
arg = getTflArgFromString(hLib, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
entry.Implementation.setReturn(arg);

arg = getTflArgFromString(hLib, 'y1','single*');
arg.IOType = 'RTW_IO_OUTPUT';
desc = RTW.ArgumentDescriptor;
desc.AlignmentBoundary = 16;
arg.Descriptor = desc;
entry.Implementation.addArgument(arg);

arg = getTflArgFromString(hLib, 'u1','single*');
desc = RTW.ArgumentDescriptor;
desc.AlignmentBoundary = 16;
arg.Descriptor = desc;
entry.Implementation.addArgument(arg);

arg = getTflArgFromString(hLib, 'u2','single*');
desc = RTW.ArgumentDescriptor;
desc.AlignmentBoundary = 16;
arg.Descriptor = desc;
entry.Implementation.addArgument(arg);

hLib.addEntry(entry);

2 Create and save the following registration file, rtwTargetInfo.m. If you want to compile the
code generated in this example, first modify the AlignmentSyntaxTemplate property for the
compiler that you use. For example, for the MSVC compiler, replace the gcc template
specification __attribute__((aligned(%n))) with __declspec(align(%n)).

function rtwTargetInfo(cm)
% rtwTargetInfo function to register a code replacement library (CRL)
% for use with  code generation
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  % Register the CRL defined in local function locCrlRegFcn
  cm.registerTargetInfo(@locCrlRegFcn);

end % End of RTWTARGETINFO

% Local function to define a CRL containing crl_table_mmul_4x4_single_align
function thisCrl = locCrlRegFcn

  % create an alignment specification object, assume gcc
  as = RTW.AlignmentSpecification;
  as.AlignmentType = {'DATA_ALIGNMENT_LOCAL_VAR', ...
                      'DATA_ALIGNMENT_GLOBAL_VAR', ...
                      'DATA_ALIGNMENT_STRUCT_FIELD'};
  as.AlignmentSyntaxTemplate = '__attribute__((aligned(%n)))';
  as.SupportedLanguages={'c', 'c++'};

  % add the alignment specification object
  da = RTW.DataAlignment;
  da.addAlignmentSpecification(as);

  % add the data alignment object to target characteristics
  tc = RTW.TargetCharacteristics;
  tc.DataAlignment = da;

  % Instantiate a CRL registry entry
  thisCrl = RTW.TflRegistry;

  % Define the CRL properties
  thisCrl.Name = 'Data Alignment Example';
  thisCrl.Description = 'Example of replacement with data alignment';
  thisCrl.TableList = {'crl_table_mmul_4x4_single_align'};
    thisCrl.TargetCharacteristics = tc;

end % End of LOCCRLREGFCN

3 To register your library with code generator without having to restart MATLAB, enter this
command:

RTW.TargetRegistry.getInstance('reset');
4 Configure the code generator to use your code replacement library.
5 Generate code and a code generation report.
6 Review the code replacements. For example, check whether a multiplication operation is

replaced with a matrix_mul_4x4_s function call. In mmalign.h, check whether the gcc
alignment directive __attribute__((aligned(16))) is generated to align the function
variables.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Math Function Code Replacement” on page 67-64
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Replace MATLAB Functions with Custom Code by Using the
coder.replace Function

You can develop a code replacement library to optimize the performance of MATLAB functions
specified within a MATLAB function block containing a coder.replace function. To develop a code
replacement library, use either the interactive or programmatic approach. For more information, see
“Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_matlab_fcn_coder_replace. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as calculate.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1, with the Data Type of double and
the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Add the return argument y1 and the arguments u1.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
  'Key', 'calculate', ...
  'Priority', 100, ...
  'ArrayLayout', 'COLUMN_MAJOR', ...
  'ImplementationName', ...
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  'replacement_calculate_impl', ...
  'ImplementationHeaderFile', ...
  'replacement_calculate_impl.h', ...
  'ImplementationSourceFile', ...
  'replacement_calculate_impl.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
  'Key', 'calculate', ...
  'Priority', 100, ...
  'ArrayLayout', 'COLUMN_MAJOR', ...
  'ImplementationName', ...
  'replacement_calculate_impl', ...
  'ImplementationHeaderFile', ...
  'replacement_calculate_impl.h', ...
  'ImplementationSourceFile', ...
  'replacement_calculate_impl.c');

%% Create the conceptual representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hEntry, 'u1','double');
addConceptualArg(hEntry, arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
  'Key', 'calculate', ...
  'Priority', 100, ...
  'ArrayLayout', 'COLUMN_MAJOR', ...
  'ImplementationName', ...
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  'replacement_calculate_impl', ...
  'ImplementationHeaderFile', ...
  'replacement_calculate_impl.h', ...
  'ImplementationSourceFile', ...
  'replacement_calculate_impl.c');

%% Create the conceptual representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hEntry, 'u1','double');
addConceptualArg(hEntry, arg);

%% Create the Conceptual Representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = getTflArgFromString(hEntry, 'u1','double');
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_matlab_fcn_coder_replace
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for matlab function with custom code using coder.replace’;
this(1).TableList = {'crl_matlab_fcn_coder_replace.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.
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See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Math Function Code Replacement” on page 67-64
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Replace coder.ceval Calls to External Functions
The coder.ceval function calls external C/C++ functions from code generated from MATLAB code.
The code replacement software supports replacement of the function that you specify in a call to
coder.ceval. An application of this code replacement scenario is to write generic MATLAB code
that you can customize for different platforms with code replacements. A code replacement library
can define hardware-specific code replacements for the function call. Use coder.ceval in MATLAB
code from which you want to generate C code using:

• MATLAB Coder
• MATLAB code in a Simulink MATLAB Function block

To develop a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 67-20.

Example Files
For the examples in “Interactively Develop a Code Replacement Library” on page 68-86 and
“Programmatically Develop a Code Replacement Library” on page 67-113 you must have set up the
following:

• Custom C function my_add.c.

/* my_add.c */

#include "my_add.h"

double my_add(double in1, double in2)
{
  return in1 + in2;
}

• Custom C header file my_add.h.

/* my_add.h */

double my_add(double in1, double in2);
• MATLAB function call_my_add.m, which uses coder.ceval to invoke my_add.c.

function y = call_my_add(in1, in2)  %#codegen

y=0.0;

if ~coder.target('Rtw')
% Executing in MATLAB, call MATLAB equivalent of C function my_add
  y= in1+in2;
else
% Executing in generated code, call C function my_add
  y = coder.ceval('my_add', in1, in2);
end

• MATLAB test function call_my_add_test.m, which calls call_my_add.m.

in1=10;
in2=20;
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y = call_my_add(in1, in2);

disp('Output')
disp('y =')
disp(y);

• Replacement C function my_add_replacement.c.

/* my_add_replacement.c */

#include "my_add_replacement.h"

double my_add_replacement(double in1, double in2)
{
  return in1 + in2;
}

• Replacement C header file my_add_replacement.h.

/* my_add_replacement.h */

double my_add_replacement(double in1, double in2);

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool

2 Create a table.

a From the crtool menu, select File > New Table.
b In the right pane, name the table crl_table_coder_cevals_calls. Click Apply.

3 Create an entry. From the crtool menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as my_add .
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input arguments, u1 and u2 with the Data Type of
double and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, set the Implementation header file to my_add_replacement.h.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool menu, select File > Save table > Save.

 Replace coder.ceval Calls to External Functions

67-111



9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable =  crl_table_coder_cevals_calls()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters( ...
          'Key', 'my_add', ...
          'Priority', 100, ...
          'ImplementationName', 'my_add_replacement', ...
          'ImplementationHeaderFile', 'my_add_replacement.h', ...
          'ImplementationSourceFile', 'my_add_replacement.c');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters( ...
          'Key', 'my_add', ...
          'Priority', 100, ...
          'ImplementationName', 'my_add_replacement', ...
          'ImplementationHeaderFile', 'my_add_replacement.h', ...
          'ImplementationSourceFile', 'my_add_replacement.c');

%% Create the conceptual representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);

arg = hEntry.getTflArgFromString('u1','double');
hEntry.addConceptualArg(arg);

arg = hEntry.getTflArgFromString('u2','double');
hEntry.addConceptualArg(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters( ...
          'Key', 'my_add', ...
          'Priority', 100, ...
          'ImplementationName', 'my_add_replacement', ...
          'ImplementationHeaderFile', 'my_add_replacement.h', ...
          'ImplementationSourceFile', 'my_add_replacement.c');

%% Create the conceptual representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);
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arg = hEntry.getTflArgFromString('u1','double');
hEntry.addConceptualArg(arg);

arg = hEntry.getTflArgFromString('u2','double');
hEntry.addConceptualArg(arg);

%% Create the implementation representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = hEntry.getTflArgFromString('u1','double');
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u2','double');
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
hTable.addEntry(hEntry); 

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable =  crl_table_coder_cevals_calls
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for coder.ceval calls to external functions code replacement’;
this(1).TableList = {' crl_table_coder_cevals_calls.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.
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See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Math Function Code Replacement” on page 67-64
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Reserved Identifiers and Code Replacement
The code generator and C programming language use, internally, reserved keywords for code
generation. Do not use reserved keywords as identifiers or function names. Reserved keywords for
code generation include many code replacement library identifiers, the majority of which are function
names, such as acos.

To view a list of reserved identifiers for the code replacement library that you use to generate code,
specify the name of the library in a call to the function
RTW.TargetRegistry.getInstance.getTflReservedIdentifiers. For example:
crl_ids = RTW.TargetRegistry.getInstance.getTflReservedIdentifiers('GNU99 (GNU)')

In a code replacement table, the code generator registers each function implementation name
defined by a table entry as a reserved identifier. You can register additional reserved identifiers for
the table on a per-header-file basis. Providing additional reserved identifiers can help prevent
duplicate symbols and other identifier-related compile and link issues.

To register additional code replacement reserved identifiers, use the setReservedIdentifiers
function. This function registers specified reserved identifiers to be associated with a code
replacement table.

You can register up to four reserved identifier structures in a code replacement table. You can
associate one set of reserved identifiers with a code replacement library, while the other three (if
present) must be associated with ANSI C. The following example shows a reserved identifier
structure that specifies two identifiers and the associated header file.
d{1}.LibraryName = 'ANSI_C';
d{1}.HeaderInfos{1}.HeaderName = 'math.h';
d{1}.HeaderInfos{1}.ReservedIds = {'y0', 'y1'};

The code generator adds the identifiers to the list of reserved identifiers and honors them during the
build procedure.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Customize Match and Replacement Process” on page 67-118
• “Define Code Replacement Library Optimizations” on page 67-36
• “Develop a Code Replacement Library” on page 67-20
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Customize Match and Replacement Process
During the build process, the code generator uses:

• Preset match criteria to identify functions and operators for which application-specific
implementations replace default implementations.

• Preset replacement function signatures.

It is possible that preset match criteria and preset replacement function signatures do not completely
meet your function and operator replacement needs. For example:

• You want to replace an operator with a particular fixed-point implementation function only when
fraction lengths are within a particular range.

• When a match occurs, you want to modify your replacement function signature based on compile-
time information, such as passing fraction-length values into the function.

To add extra logic into the code replacement match and replacement process, create custom code
replacement table entries. With custom entries, you can specify additional match criteria and modify
the replacement function signature to meet application needs.

To create a custom code replacement entry:

1 Create a custom code replacement entry class, derived from RTW.TflCFunctionEntryML (for
function replacement) or RTW.TflCOperationEntryML (for operator replacement).

2 In your derived class, implement a do_match method with a fixed preset signature as a MATLAB
function. In your do_match method, provide either or both of the following customizations that
instantiate the class:

• Add match criteria that the base class does not provide. The base class provides a match
based on:

• Argument number
• Argument name
• Signedness
• Word size
• Slope (if not specified with wildcards)
• Bias (if not specified with wildcards)
• Math modes, such as saturation and rounding
• Operator or function key

• Modify the implementation signature by adding additional arguments or setting constant
input argument values. You can inject a constant value, such as an input scaling value, as an
additional argument to the replacement function.

3 Create code replacement entries that instantiate the custom entry class.
4 Register a library containing the code replacement table that includes your entries.

During code generation, the code replacement match process tries to match function or operator call
sites with the base class of your derived entry class. If the process finds a match, the software calls
your do_match method to execute your additional match logic (if any) and your replacement function
customizations (if any).
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Customize Code Match and Replacement for Functions
This example shows how to use custom code replacement table entries to refine the match and
replacement logic for functions. The example shows how to:

• Modify a sine function replacement only if the integer size on the current target platform is 32
bits.

• Change the replacement such that the implementation function passes in a degrees-versus-radians
flag as an input argument.

1 To exercise the table entries that you create in this example, create an ERT-based model with a
sine function block. For example:

In the Inport block parameters, set the signal Data type to double. If the value selected for
Configuration Parameters > Hardware Implementation > Device type supports an integer
size other than 32, do one of the following:

• Select a temporary target platform with a 32-bit integer size.
• Modify the code to match the integer size of your target platform.

2 Create a class, for example TflCustomFunctionEntry, that is derived from the base class
RTW.TflCFunctionEntryML. The derived class defines a do_match method with the signature:

function ent = do_match(hThis, ...
        hCSO, ...
        targetBitPerChar, ...
        targetBitPerShort, ...
        targetBitPerInt, ...
        targetBitPerLong, ...
        targetBitPerLongLong) 

In the do_match signature:

• ent is the return handle, which is returned either as empty (indicating that the match failed)
or as a TflCFunctionEntry handle.

• hThis is a handle to the class instance.
• hCSO is a handle to an object that the code generator creates for querying the library for a

replacement.
• Remaining arguments are the number of bits for various data types of the current target.

The do_match method:

• Adds required additional match criteria that the base class does not provide.
• Makes required modifications to the implementation signature.

In this case, the do_match method must match only targetBitPerInt, representing the
number of bits in the C int data type for the current target, to the value 32. If the code
generator finds a match, the method sets the return handle and creates and adds an input
argument. The input argument represents whether units are expressed as degrees or radians, to
the replacement function signature.
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Alternatively, create and add the additional implementation function argument for passing a units
flag in each code replacement table definition file that instantiates this class. In that case, this
class definition code does not create the argument. That code sets only the argument value. For
an example of creating and adding additional implementation function arguments in a table
definition file, see “Customize Code Match and Replacement for Scalar Operations” on page 67-
124.
classdef TflCustomFunctionEntry < RTW.TflCFunctionEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok
      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This will check additional data and perhaps modify
      % the implementation function.

      ent = []; % default the return to empty, indicating the match failed.

      % Match sine function only if the target int size is 32 bits
      if targetBitPerInt == 32
        % Need to modify the default implementation, starting from a copy
        % of the standard TflCFunctionEntry.
        ent = RTW.TflCFunctionEntry(hThis);

        % If the target int size is 32 bits, the implementation function
        % takes an additional input flag argument indicating degress vs.
        % radians. The additional argument can be created and added either
        % in the CRL table definition file that instantiates this class, or
        % here in the class definition, as follows:
        createAndAddImplementationArg(ent, 'RTW.TflArgNumericConstant', ...
                                      'Name',           'u2', ...
                                      'IsSigned',       true, ...
                                      'WordLength',     32, ...
                                      'FractionLength', 0, ...
                                      'Value',          1);
      end
    end
  end
end

Exit the class folder and return to the previous working folder.
3 Create and save the following code replacement table definition file,

crl_table_custom_sinfcn_double.m. This file defines a code replacement table that
contains a function table entry for sine with double input and output. This entry instantiates the
derived class from the previous step, TflCustomFunctionEntry.
function hTable = crl_table_custom_sinfcn_double

hTable = RTW.TflTable;

%% Add TflCustomFunctionEntry
fcn_entry = TflCustomFunctionEntry;
setTflCFunctionEntryParameters(fcn_entry, ...
    'Key',                      'sin', ...
    'Priority',                 30, ...
    'ImplementationName',       'mySin', ...
    'ImplementationHeaderFile', 'mySin.h', ...
    'ImplementationSourceFile', 'mySin.c');

createAndAddConceptualArg(fcn_entry, 'RTW.TflArgNumeric', ...
     'Name',         'y1', ...
     'IOType',       'RTW_IO_OUTPUT', ...
     'DataTypeMode', 'double');
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createAndAddConceptualArg(fcn_entry, 'RTW.TflArgNumeric', ...
     'Name',         'u1', ...
     'IOType',       'RTW_IO_INPUT', ...
     'DataTypeMode', 'double');

% TflCustomFunctionEntry class do_match method will create and add
% an implementation function argument during code generation if
% the supported integer size on the current target is 32 bits.
copyConceptualArgsToImplementation(fcn_entry);

addEntry(hTable, fcn_entry);

4 Check the validity of the code replacement table entry.

• At the command prompt, invoke the table definition file.

tbl = crl_table_custom_sinfcn_double
• In the Code Replacement Viewer, view the table definition file.

crviewer(crl_table_custom_sinfcn_double)

Customize Code Match and Replacement for Nonscalar Operations
This example shows how to create custom code replacement entries that add logic to the code match
and replacement process for a nonscalar operation. Custom entries specify additional match criteria
or modify the replacement function signature to meet application needs.

This example restricts the match criteria for an element-wise multiplication replacement to entries
with a specific dimension range. When a match occurs, the custom do_match method modifies the
replacement signature to pass the number of elements into the function.

Files for developing and testing this code replacement library example are available in matlab/
help/toolbox/ecoder/examples/code_replacement/custom_elemmult:

• do_match method — @MyElemMultEntry/MyElemMultEntry.m
• Replacement function source and header files — src/myMulImplLib.c and src/

myMulImplLib.h
• Model — myElemMul.slx
• Code replacement table definition — myElemMultCrlTable.m
• Registration file — rtwTargetInfo.m

To create custom code replacement entries that add logic to the code replacement match and
replacement process:

1 Create a class, for example MyElemMultEntry, which is derived from the base class
RTW.TflCOperationEntryML. The derived class defines a do_match method with the following
signature:

function ent = do_match(hThis, ...
    hCSO, ... 
    targetBitPerChar, ...
    targetBitPerShort, ...
    targetBitPerInt, ...
    targetBitPerLong, ...
    targetBitPerLongLong)

In the do_match signature:
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• ent is the return handle, which is returned as empty (indicating that the match failed) or as a
TflCOperationEntry handle.

• hThis is the handle to the derived instance.
• hCSO is a handle to an object that the code generator creates for querying the library for a

replacement.
• Remaining arguments are the number of bits for various data types of the current target.

The do_match method:

• Adds match criteria that the base class does not provide.
• Makes changes to the implementation signature.

The do_match method relies on the base class for checking data types and dimension ranges. If
the code generator finds a match, do_match:

• Sets the return handle.
• Uses the conceptual arguments to compute the number of elements in the array. In the

replacement entry returned, sets the value of the constant implementation argument as the
number of elements of the array.

• Updates the code replacement entry such that it matches CSOs that have the same argument
dimensions.

classdef MyElemMultEntry < RTW.TflCOperationEntryML
    methods
        function obj = MyElemMultEntry(varargin)
            mlock;
            obj@RTW.TflCOperationEntryML(varargin{:});
        end
        
        function ent = do_match(hThis, ...
            hCSO, ... %#ok
            targetBitPerChar, ... %#ok
            targetBitPerShort, ... %#ok
            targetBitPerInt, ... %#ok
            targetBitPerLong, ... %#ok
            targetBitPerLongLong ) %#ok
            
            %  Fourth implementation arg represents number of elements for producing matches.
            assert(strcmp(hThis.Implementation.Arguments(4).Name,'numElements'));
            
            ent = RTW.TflCOperationEntry(hThis);
            
            % Calculate number of elements and set value of injected constant.
            ent.Implementation.Arguments(4).Value = prod(hCSO.ConceptualArgs(1).DimRange(1,:));
            
            % Since implementation has been modified for specific DimRange, update 
            % returned entry to match similar CSOs only.
            for idx =1:3
                ent.ConceptualArgs(idx).DimRange = hCSO.ConceptualArgs(idx).DimRange;
            end
        end
    end
end

2 Create and save the following code replacement table definition file, myElemMultCrlTable.m.
This file defines a code replacement table that contains an operator entry generator for element-
wise multiplication. The table entry:

• Instantiates the derived class myElemMultEntry from the previous step.
• Sets operator entry parameters with the call to

the setTflCOperationEntryParameters function.
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• Creates conceptual arguments y1, u1, and u2. The argument class RTW.TflArgMatrix
specifies matrix arguments to match. The three arguments are set up to match 2-dimensional
matrices with at least two elements in each dimension.

• Calls the getTflArgFromString function to create a return value and four implementation
arguments. Arguments u1 and u2 are the operands, y1 is the product, and the fourth
argument is the number of elements.

Alternatively, the do_match method of the derived class myElemMultEntry can create and
add the implementation arguments. When the number of additional implementation
arguments required can vary based on compile-time information, use the alternative
approach.

• Calls addEntry to add the entry to a code replacement table.

function hLib = myElemMultCrlTable

libPath = fullfile(fileparts(which(mfilename)),'src');

hLib = RTW.TflTable;
%---------- entry: RTW_OP_ELEM_MUL ----------- 
hEnt = MyElemMultEntry;
hEnt.setTflCOperationEntryParameters( ...
          'Key', 'RTW_OP_ELEM_MUL', ...
          'Priority', 100, ...
          'SaturationMode', 'RTW_WRAP_ON_OVERFLOW', ...
          'ImplementationName', 'myElemMul_s32', ...
          'ImplementationSourceFile', 'myMulImplLib.c', ...
          'ImplementationSourcePath', libPath, ...
          'ImplementationHeaderFile', 'myMulImplLib.h', ...
          'ImplementationHeaderPath', libPath, ...
          'SideEffects', true, ...
          'GenCallback','RTW.copyFileToBuildDir');

% Conceptual Args

arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'int32');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'int32');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'int32');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

% Implementation Args 

arg = hEnt.getTflArgFromString('unused','void');
arg.IOType = 'RTW_IO_OUTPUT';
hEnt.Implementation.setReturn(arg); 

arg = hEnt.getTflArgFromString('u1','int32*');
hEnt.Implementation.addArgument(arg);

arg = hEnt.getTflArgFromString('u2','int32*');
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hEnt.Implementation.addArgument(arg);

arg = hEnt.getTflArgFromString('y1','int32*');
arg.IOType = 'RTW_IO_OUTPUT';
hEnt.Implementation.addArgument(arg);

arg = hEnt.getTflArgFromString('numElements','uint32',0);
hEnt.Implementation.addArgument(arg);

hLib.addEntry( hEnt );
3 Check the validity of the code replacement table entry.

• At the command prompt, invoke the table definition file.

tbl = myElemMultCrlTable

• In the Code Replacement Viewer, view the table definition file.

crviewer(myElemMultCrlTable)

Customize Code Match and Replacement for Scalar Operations
This example shows how to create custom code replacement entries that add logic to the code match
and replacement process for a scalar operation. Custom entries specify additional match criteria or
modify the replacement function signature to meet application needs.

For example:

• When fraction lengths are within a specific range, replace an operator with a fixed-point
implementation function.

• When a match occurs, modify the replacement function signature based on compile-time
information, such as passing fraction-length values into the function.

This example modifies a fixed-point addition replacement such that the implementation function
passes in the fraction lengths of the input and output data types as arguments.

To create custom code replacement entries that add logic to the code replacement match and
replacement process:

1 Create a class, for example TflCustomOperationEntry, that is derived from the base class
RTW.TflCOperationEntryML. The derived class defines a do_match method with the following
signature:

function ent = do_match(hThis, ...
        hCSO, ...
        targetBitPerChar, ...
        targetBitPerShort, ...
        targetBitPerInt, ...
        targetBitPerLong, ...
        targetBitPerLongLong) 

In the do_match signature:

• ent is the return handle, which is returned as empty (indicating that the match failed) or as a
TflCOperationEntry handle.
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• hThis is the handle to the class instance.
• hCSO is a handle to an object that the code generator creates for querying the library for a

replacement.
• Remaining arguments are the number of bits for various data types of the current target.

The do_match method adds match criteria that the base class does not provide. The method
makes modifications to the implementation signature. In this case, the do_match method relies
on the base class for checking word size and signedness. do_match must match only the number
of conceptual arguments to the value 3 (two inputs and one output) and the bias for each
argument to value 0. If the code generator finds a match, do_match:

• Sets the return handle.
• Removes slope and bias wild cards from the conceptual arguments (the match is for specific

slope and bias values).
• Writes fraction-length values for the inputs and output into replacement function arguments

3, 4, and 5.

You can create and add three additional implementation function arguments for passing fraction
lengths in the class definition or in each code replacement entry definition that instantiates this
class. This example creates the arguments, adds them to a code replacement table definition file,
and sets them to specific values in the class definition code.
classdef TflCustomOperationEntry < RTW.TflCOperationEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok

      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This class will check additional data and can
      % modify the implementation function.

      % The base class checks word size and signedness. Slopes and biases
      % have been wildcarded, so the only additional checking to do is
      % to check that the biases are zero and that there are only three
      % conceptual arguments (one output, two inputs)

      ent = []; % default the return to empty, indicating the match failed

      if length(hCSO.ConceptualArgs) == 3 && ...
          hCSO.ConceptualArgs(1).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(2).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(3).Type.Bias == 0

        % Modify the default implementation. Since this is a
        % generator entry, a concrete entry is created using this entry
        % as a template. The type of entry being created is a standard
        % TflCOperationEntry. Using the standard operation entry
        % provides required information, and you do not need
        % a custom match function.
        ent = RTW.TflCOperationEntry(hThis);

        % Since this entry is modifying the implementation for specific
        % fraction-length values (arguments 3, 4, and 5), the conceptual argument
        % wild cards must be removed (the wildcards were inherited from the
        % generator when it was used as a template for the concrete entry).
        % This concrete entry is now for a specific slope and bias. 
        % hCSO holds the slope and bias values (created by the code generator).
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        for idx=1:3
          ent.ConceptualArgs(idx).CheckSlope = true;
          ent.ConceptualArgs(idx).CheckBias = true;

          % Set the specific Slope and Biases
          ent.ConceptualArgs(idx).Type.Slope = hCSO.ConceptualArgs(idx).Type.Slope;
          ent.ConceptualArgs(idx).Type.Bias = 0;
        end

        % Set the fraction-length values in the implementation function.
        ent.Implementation.Arguments(3).Value = ...
           -1.0*hCSO.ConceptualArgs(2).Type.FixedExponent;
        ent.Implementation.Arguments(4).Value = ...
           -1.0*hCSO.ConceptualArgs(3).Type.FixedExponent;
        ent.Implementation.Arguments(5).Value = ...
           -1.0*hCSO.ConceptualArgs(1).Type.FixedExponent;
      end
    end
  end
end

Exit the class folder and return to the previous working folder.
2 Create and save the following code replacement table definition file,

crl_table_custom_add_ufix32.m. This file defines a code replacement table that contains a
single operator entry, an entry generator for unsigned 32-bit fixed-point addition operations, with
arbitrary fraction-length values on the inputs and the output. The table entry:

• Instantiates the derived class TflCustomOperationEntry from the previous step. If you
want to replace word sizes and signedness attributes, you can use the same derived class, but
not the same entry, because you cannot use a wild card with the WordLength and IsSigned
arguments. For example, to support uint8, int8, uint16, int16, and int32, add five other
distinct entries. To use different implementation functions for saturation and rounding modes
other than overflow and round to floor, add entries for those match permutations.

• Sets operator entry parameters with the call to
the setTflCOperationEntryParameters function.

• Calls the createAndAddConceptualArg function to create conceptual arguments y1, u1,
and u2.

• Calls createAndSetCImplementationReturn and createAndAddImplementationArg
to define the signature for the replacement function. Three of the calls to
createAndAddImplementationArg create implementation arguments to hold the fraction-
length values for the inputs and output. Alternatively, the entry can omit those argument
definitions. Instead, the do_match method of the derived class TflCustomOperationEntry
can create and add the three implementation arguments. When the number of additional
implementation arguments required can vary based on compile-time information, use the
alternative approach.

• Calls addEntry to add the entry to a code replacement table.

function hTable = crl_table_custom_add_ufix32

hTable = RTW.TflTable;

% Add TflCustomOperationEntry
op_entry = TflCustomOperationEntry;

setTflCOperationEntryParameters(op_entry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
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    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

createAndAddConceptualArg(op_entry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'BinaryPoint', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(op_entry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'BinaryPoint', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(op_entry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'BinaryPoint', ...
       'IsSigned',   false, ...
       'WordLength', 32);

% Specify replacement function signature
createAndSetCImplementationReturn(op_entry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 3 fraction-length args. Actual values are set during code generation.
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createAndAddImplementationArg(op_entry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_out', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

addEntry(hTable, op_entry);
3 Check the validity of the operator entry.

• At the command prompt, invoke the table definition file.

tbl = crl_table_custom_add_ufix32
• In the Code Replacement Viewer, view the table definition file.

crviewer(crl_table_custom_add_ufix32)

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Define Code Replacement Library Optimizations” on page 67-36
• “Develop a Code Replacement Library” on page 67-20
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Scalar Operator Code Replacement
This example shows how to develop a code replacement library to optimize the performance of scalar
operators by providing information on how to define code replacement for a multiply operation. To
develop a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_scalar. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Operation drop-down list, select Multiply.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input arguments, u1 and u2 with the Data Type of
double and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:
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>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_scalar()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function .

function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.
function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                    'Key',                      'RTW_OP_MUL', ...
                    'Priority',                 90, ...
                    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
                    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
                    'ImplementationName',       'u8_mul_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_mul_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_mul_u8_u8.c' );

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.
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function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                    'Key',                      'RTW_OP_MUL', ...
                    'Priority',                 90, ...
                    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
                    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
                    'ImplementationName',       'u8_mul_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_mul_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_mul_u8_u8.c' );

%% Create the conceptual representation
arg = getTflArgFromString(hTable, 'y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'double');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTable, 'u2', 'double');
addConceptualArg(hEntry, arg );

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                    'Key',                      'RTW_OP_MUL', ...
                    'Priority',                 90, ...
                    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
                    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
                    'ImplementationName',       'u8_mul_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_mul_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_mul_u8_u8.c' );

%% Create the conceptual representation
arg = getTflArgFromString(hTable, 'y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'double');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTable, 'u2', 'double');
addConceptualArg(hEntry, arg );

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);
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%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_scalar
9 Create a registration file for the code replacement library with these specifications:

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for scalar operator replacement';
this(1).TableList = {'crl_table_scalar.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Shift Left Operations and Code Replacement” on page 67-205
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Addition and Subtraction Operator Code Replacement
This example shows how to develop a code replacement library to optimize the performance of
addition and subtraction operators by providing information on how to define code replacement for a
addition operator. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
67-20.

Algorithm Options
When creating a code replacement table entry for an addition or subtraction operator, first determine
the type of algorithm that your library function implements.

• Cast-before-operation (CBO), default — Prior to performing the addition or subtraction operation,
the algorithm type casts input values to the output type. If the output data type cannot exactly
represent the input values, losses can occur as a result of the cast to the output type. Additional
loss can occur when the result of the operation is cast to the final output type.

• Cast-after-operation (CAO) — The algorithm computes the ideal result of the addition or
subtraction operation of the two inputs. The algorithm then type casts the result to the output
data type. Loss occurs during the type cast. This algorithm behaves similarly to the C language
except when the signedness of the operands does not match. For example, when you add a signed
long operand to an unsigned long operand, standard C language rules convert the signed long
operand to an unsigned long operand. The result is a value that is not ideal.

Algorithm Classification
During code generation, the code generator examines addition and subtraction operations, including
adjacent type cast operations, to determine the type of algorithm to compute the expression result.
Based on the data types in the expression and the type of the accumulator (type used to hold the
result of the addition or subtraction operation), the code generator uses these rules.

• Floating-point types only

Input 1 Data
Type

Input 2 Data
Type

Accumulator Data
Type

Output Data Type Classificati
on

double double double double CBO, CAO
double double double single —
double double single double —
double double single single CBO
double single double double CBO, CAO
double single double single —
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Input 1 Data
Type

Input 2 Data
Type

Accumulator Data
Type

Output Data Type Classificati
on

double single single double —
double single single single CBO
single single single single CBO, CAO
single single single double —
single single double single —
single single double double CBO, CAO

• Floating-point and fixed-point types on the immediate addition or subtraction operation

Algorithm Conditions
CBO One of the following is true:

• Operation type is double.
• Operation type is single and input types are single or fixed-point.

CAO Operation type is a superset of input types—that is, output type can represent
values of input types without loss of data.

• Fixed-point types only

Algorithm Conditions
CBO At least one of the following is true:

• Accumulator type equals output type (Tacc == Tout).
• Output type is a superset of input types (Tacc >= {Tin1, Tin2}) and

accumulator type is a superset of output type (Tacc >= Tout).
• Operation does not incur range or precision loss.

CAO Net bias is zero and the data types in the expression have equal slope
adjustment factors. For more information on net bias, see “Addition” or
“Subtraction” in “Fixed-Point Operator Code Replacement” on page 68-134 (for
MATLAB code) or “Fixed-Point Operator Code Replacement” on page 67-169 (for
Simulink models).

In many cases, the numerical result of a CBO operation is equal to that of a CAO operation. For
example, if the input and output types are such that the operation produces the ideal result, as in the
case of int8 + int8 —> int16. To maximize the probability of code replacement occurring in such
cases, set the algorithm to cast-after-operation.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
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b In the right pane, name the table crl_table_addition. Click Apply.
3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Function drop-down list, select Addition. Algorithm

information appears in the crtool. For this example, select the parameter to Cast before
operation.

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of uint8 and the Argument Type of Scalar,
the input arguments, u1 and u2 with the Data Type of uint16 and the Argument Type of
Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.
function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                   'Key',                      'RTW_OP_ADD', ...
                   'EntryInfoAlgorithm',       'RTW_CAST_BEFORE_OP', ...
                   'ImplementationName',       'u8_add_cao_u16_u16');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.
function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 
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%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                   'Key',                      'RTW_OP_ADD', ...
                   'EntryInfoAlgorithm',       'RTW_CAST_BEFORE_OP', ...
                   'ImplementationName',       'u8_add_cao_u16_u16');

%% Create the conceptual representation
arg = getTflArgFromString(hTflTable, 'y1', 'uint8');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTflTable, 'u1', 'uint16');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTflTable, 'u2', 'uint16');
addConceptualArg(hEntry, arg );

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTflTable = make_cbo_add_crl_table()
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                   'Key',                      'RTW_OP_ADD', ...
                   'EntryInfoAlgorithm',       'RTW_CAST_BEFORE_OP', ...
                   'ImplementationName',       'u8_add_cao_u16_u16');

%% Create the conceptual representation
arg = getTflArgFromString(hTflTable, 'y1', 'uint8');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTflTable, 'u1', 'uint16');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTflTable, 'u2', 'uint16');
addConceptualArg(hEntry, arg );

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
addEntry(hTflTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = make_cbo_add_crl_table
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9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for addition subtraction operator replacement’;
this(1).TableList = {'make_cbo_add_crl_table.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations

10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Limitations
• The code generator does not replace operations with nonzero net bias.
• When classifying an operation as a CAO operation, the code generator includes the adjacent casts

in the expression when the expression involves only fixed-point types. Otherwise, the code
generator classifies and replaces only the immediate addition or subtraction operation. Casts that
the code generator excludes from the classification appear in the generated code.

• To enable the code generator to include multiple cast operations, which follow an addition or
subtraction of fixed-point data, in the classification of an expression, the rounding mode must be
simplest or floor. Consider the expression y=(cast A)(cast B)(u1+u2). If the rounding
mode of (cast A), (cast B), and the addition operator (+) are set to simplest or floor, the
code generator takes into account (cast A) and (cast B) when classifying the expression and
performing the replacement only.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Shift Left Operations and Code Replacement” on page 67-205
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Matrix Multiplication Operation to MathWorks BLAS Code
Replacement

You can develop a code replacement library for floating-point matrix/matrix and matrix/vector
multiplication operations with the multiplication functions dgemm and dgemv defined in the
MathWorks BLAS library. If you use a third-party BLAS library for replacement, you must change the
build requirements in this example to point to your library. To develop a code replacement library use
either the interactive or programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_blas. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Blas Operation
(Fortran).

4 Create entry parameters. In the Function drop-down list, select Multiply.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of
double and the Argument Type of Matrix.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. Set the BLAS level to
2(Vector).

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_blas
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflBlasEntryGenerator.
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
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%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_MUL', ...
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    'Priority',                 100, ...
    'ImplementationName',       'dgemm32', ...
    'ImplementationHeaderFile', 'blascompat32_crl.h', ...
    'ImplementationHeaderPath', fullfile('$(MATLAB_ROOT)','extern','include'), ...
    'AdditionalLinkObjs',       {['libmwblascompat32.' libExt]}, ...
    'AdditionalLinkObjsPaths',  {LibPath}, ...
    'SideEffects',              true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg. To specify a matrix argument in the function call, use the
argument class RTW.TflArgMatrix and specify the base type and the dimensions for which the
argument is valid. This type of table entry supports a range of dimensions specified in the format
[Dim1Min Dim2Min ... DimNMin; Dim1Max Dim2Max ... DimNMax]. For example, [2 2;
inf inf] means a two-dimensional matrix of size 2x2 or larger. The conceptual output argument for
the dgemm32 entry for matrix/matrix multiplication replacement specifies dimensions [2 2; inf
inf], while the conceptual output argument for the dgemv32 entry for matrix/vector
multiplication replacement specifies dimensions [2 1; inf 1].
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_MUL', ...
    'Priority',                 100, ...
    'ImplementationName',       'dgemm32', ...
    'ImplementationHeaderFile', 'blascompat32_crl.h', ...
    'ImplementationHeaderPath', fullfile('$(MATLAB_ROOT)','extern','include'), ...
    'AdditionalLinkObjs',       {['libmwblascompat32.' libExt]}, ...
    'AdditionalLinkObjsPaths',  {LibPath}, ...
    'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
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                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [1 1; inf inf]);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString. The example code configures special implementation arguments that
are required for dgemm and dgemv function replacements. The convenience methods setReturn
and addArgument specify whether an argument is a return value or argument and adds the
argument to the entry’s array of implementation arguments. Add the complete entry to the table
by calling the function addEntry.
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_MUL', ...
    'Priority',                 100, ...
    'ImplementationName',       'dgemm32', ...
    'ImplementationHeaderFile', 'blascompat32_crl.h', ...
    'ImplementationHeaderPath', fullfile('$(MATLAB_ROOT)','extern','include'), ...
    'AdditionalLinkObjs',       {['libmwblascompat32.' libExt]}, ...
    'AdditionalLinkObjsPaths',  {LibPath}, ...
    'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
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                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [1 1; inf inf]);

%% Create the Implementation Representation
% Using RTW.TflBlasEntryGenerator for xgemm requires the following
% implementation signature:
%
% void f(char* TRANSA, char* TRANSB, int* M, int* N, int* K,
%        type* ALPHA, type* u1, int* LDA, type* u2, int* LDB,
%        type* BETA, type* y, int* LDC)
%
% When a match occurs, the code generator computes the
% values for M, N, K, LDA, LDB, and LDC and inserts them into the
% generated code. TRANSA and TRANSB are set to 'N'.

% Specify replacement function signature

arg = getTflArgFromString(hTable, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg);

arg = RTW.TflArgCharConstant('TRANSA');
% Possible values for PassByType property are
%  RTW_PASSBY_AUTO, RTW_PASSBY_POINTER,
%  RTW_PASSBY_VOID_POINTER, RTW_PASSBY_BASE_POINTER
arg.PassByType = 'RTW_PASSBY_POINTER';
hEntry.Implementation.addArgument(arg);

arg = RTW.TflArgCharConstant('TRANSB');
arg.PassByType = 'RTW_PASSBY_POINTER';
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'M', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'N', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'K', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'ALPHA', 'double', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u1', ['double' '*']);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'LDA', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', ['double' '*']);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'LDB', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'BETA', 'double', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);
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arg = getTflArgFromString(hTable, 'y1', ['double' '*']);
arg.IOType = 'RTW_IO_OUTPUT';
arg.PassByType = 'RTW_PASSBY_POINTER';
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'LDC', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_blas
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for matrix multiplication for Mathworks Blas code’;
this(1).TableList = {'crl_table_blas.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Convert a Matrix Multiplication Operation to MathWorks BLAS
Through Code Replacement
In this section, you generate code using the code replacement library that you created in the first two
sections of this example. A floating-point matrix/matrix multiplication operation is replaced with a
custom multiplication function dgemm in the generated code. This example does not provide an
implementation function. Write your own implementation.

Example Model

Open the model crl_blas for configuring the code replacement library.
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open_system('crl_blas');

copyfile BlasTargetInfo.txt rtwTargetInfo.m

Run the MATLAB customization file to create a code replacement table and register the file. The
customization file has already been executed. Run the sl_refresh_customizations function to register
the library.

sl_refresh_customizations;

Enable Code Replacement Library

1 Open the Configuration Parameters dialog box.
2 On the Interface pane, set Code Replacement Library by clicking Select and adding CRL for

matrix multiplication for Mathworks Blas code to the Selected code replacement
libraries - prioritized list pane. Alternatively, use the command-line API to enable the code
replacement:

set_param('crl_blas', 'CodeReplacementLibrary', 'CRL for matrix multiplication for Mathworks Blas code');

Generate code from the model:

evalc('slbuild(''crl_blas'')');

View the generated code. Here is a portion of crl_blas.c.

cfile = fullfile('crl_blas_ert_rtw','crl_blas.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void crl_blas_step(void)
{
  real_T ALPHA;
  real_T BETA;
  int32_T K;
  int32_T LDA;
  int32_T LDB;
  int32_T LDC;
  int32_T M;
  int32_T N;
  char_T TRANSA;
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  char_T TRANSB;

  /* Product: '<Root>/DGEMM32' */
  TRANSA = 'N';
  TRANSB = 'N';
  M = 10;
  N = 10;
  K = 20;
  ALPHA = 1.0;
  LDA = 10;
  LDB = 20;
  BETA = 0.0;
  LDC = 10;

  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Product: '<Root>/DGEMM32'
   */
  dgemm32(&TRANSA, &TRANSB, &M, &N, &K, &ALPHA, &rtU.In1[0], &LDA, &rtU.In2[0],
          &LDB, &BETA, &rtY.Out1[0], &LDC);

  /* MATLAB Function: '<Root>/DGEMM32_2' */
  /* MATLAB Function 'DGEMM32_2': '<S1>:1' */
  /* '<S1>:1:5' */
  TRANSA = 'N';
  TRANSB = 'N';

  /* Outport: '<Root>/Out7' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  MATLAB Function: '<Root>/DGEMM32_2'
   */
  dgemm32(&TRANSA, &TRANSB, &M, &N, &K, &ALPHA, &rtU.In1[0], &LDA, &rtU.In2[0],
          &LDB, &BETA, &rtY.Out7[0], &LDC);
}

The matrix/matrix multiplication operation is repalced with the custom dgemm32 function.

Close the model and code generation report.

delete ./rtwTargetInfo.m
bdclose('crl_blas');
rtwdemoclean;

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Matrix Multiplication Operation to ANSI/ISO C BLAS Code Replacement” on page 67-151
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Matrix Multiplication Operation to ANSI/ISO C BLAS Code
Replacement

You can develop a code replacement library for floating-point matrix/matrix and matrix/vector
multiplication operations with the multiplication functions sgemm defined in the MathWorks C BLAS
library. Use a third-party C BLAS library for replacement and change the build requirements in this
example to point to your library. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_cblas. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > CBlas Operation
(Atlas).

4 Create entry parameters. In the Function drop-down list, select Multiply.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of single
and the Argument Type of Matrix.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. Set the BLAS level to
3(Vector).

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_cblas
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCBlasEntryGenerator.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry

 Matrix Multiplication Operation to ANSI/ISO C BLAS Code Replacement

67-153



%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters( ...
    'Key', 'RTW_OP_MUL', ...
    'Priority', 100, ...
    'ImplementationName', 'cblas_sgemm', ...
    'ImplementationSourceFile', 'ccblas.c', ...
    'ImplementationHeaderFile', 'ccblas.h', ...
    'AdditionalIncludePaths',   {LibPath}, ...
    'AdditionalLinkObjs',       {['libcblas' libExt]}, ...
    'AdditionalLinkFlags',        {'-lgfortran'},...
    'SideEffects', true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg. To specify a matrix argument in the function call, use the
argument class RTW.TflArgMatrix and specify the base type and the dimensions for which the
argument is valid. This type of table entry supports a range of dimensions specified in the format
[Dim1Min Dim2Min ... DimNMin; Dim1Max Dim2Max ... DimNMax]. For example, [2 2;
inf inf] means a two-dimensional matrix of size 2x2 or larger.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
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    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters( ...
    'Key', 'RTW_OP_MUL', ...
    'Priority', 100, ...
    'ImplementationName', 'cblas_sgemm', ...
    'ImplementationSourceFile', 'ccblas.c', ...
    'ImplementationHeaderFile', 'ccblas.h', ...
    'AdditionalIncludePaths',   {LibPath}, ...
    'AdditionalLinkObjs',       {['libcblas' libExt]}, ...
    'AdditionalLinkFlags',      {'-lgfortran'},...
    'SideEffects', true);

%% Create the conceptual representation
arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'single');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'single');
arg.DimRange = [2 1; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'single');
arg.DimRange = [1 2; Inf Inf];
hEnt.addConceptualArg(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString. The example code configures special implementation arguments that
are required for dgemm and dgemv function replacements. The convenience methods setReturn
and addArgument specify whether an argument is a return value or argument and adds the
argument to the entry’s array of implementation arguments. Add the complete entry to the table
by calling the function addEntry.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters( ...
    'Key', 'RTW_OP_MUL', ...
    'Priority', 100, ...
    'ImplementationName', 'cblas_sgemm', ...
    'ImplementationSourceFile', 'ccblas.c', ...
    'ImplementationHeaderFile', 'ccblas.h', ...
    'AdditionalIncludePaths',   {LibPath}, ...
    'AdditionalLinkObjs',       {['libcblas' libExt]}, ...
    'AdditionalLinkFlags',      {'-lgfortran'},...
    'SideEffects', true);

%% Create the conceptual representation
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arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'single');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'single');
arg.DimRange = [2 1; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'single');
arg.DimRange = [1 2; Inf Inf];
hEnt.addConceptualArg(arg);

%% Create the Implementation Representation
% Using RTW.TflCBlasEntryGenerator for sgemm requires the following
% implementation signature:
%
% void no_name( const integer ORDER, const integer TRANSA, const integer TRANSB, 
% const integer M, const integer N, const integer K, const double ALPHA, 
% const double* u1, const integer LDA, const double* u2, const integer LDB, 
% const double BETA, double* y1, const integer LDC );
%
% When a match occurs, the code generator computes the
% values for M, N, K, LDA, LDB, and LDC and inserts them into the
% generated code. TRANSA and TRANSB are set to 'N'.

% Specify replacement function signature
arg = hEntry.getTflArgFromString('y2','void');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = hEntry.getTflArgFromString('ORDER','integer',102.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('TRANSA','integer',111.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('TRANSB','integer',111.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('M','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('N','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('K','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('ALPHA','double',1.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u1','single*');
arg.Type.BaseType.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('LDA','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u2','single*');
arg.Type.BaseType.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('LDB','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('BETA','double',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('y1','single*');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.addArgument(arg);
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arg = hEntry.getTflArgFromString('LDC','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_cblas
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for matrix multiplication for Mathworks CBlas code’;
this(1).TableList = {'crl_table_cblas.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Matrix Multiplication Operation to MathWorks BLAS Code Replacement” on page 67-141
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Small Matrix Operation to Processor Code Replacement
This example shows how to develop a code replacement library to optimize the performance of non-
scalar small matrix operations with processor-specific intrinsic functions by providing information on
how to define code replacement for a addition operator. To develop a code replacement library use
either the interactive or programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_small_matrix. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Function drop-down list, select Addition. Algorithm

information appears in the crtool. For this example, select the parameter to Cast before
operation.

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of double and the Argument Type of
Matrix, the input argument, u1 with the Data Type of double and the Argument Type of
Matrix and the input argument, u2 with the Data Type of double and the Argument Type of
Matrix.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. Specify the return
argument y1, u1 and u2, with the Data Type of double and select the Pointer dialog box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
     'Key',                      'RTW_OP_ADD', ...
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     'Priority',                 30, ...
     'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
     'ImplementationName',       'matrix_sum_2x2_double', ...
     'ImplementationHeaderFile', 'MatrixMath.h', ...
     'ImplementationSourceFile', 'MatrixMath.c', ...
     'ImplementationHeaderPath', LibPath, ...
     'ImplementationSourcePath', LibPath, ...
     'AdditionalIncludePaths',   {LibPath}, ...
     'GenCallback',              'RTW.copyFileToBuildDir', ...
     'SideEffects',              true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
     'Key',                      'RTW_OP_ADD', ...
     'Priority',                 30, ...
     'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
     'ImplementationName',       'matrix_sum_2x2_double', ...
     'ImplementationHeaderFile', 'MatrixMath.h', ...
     'ImplementationSourceFile', 'MatrixMath.c', ...
     'ImplementationHeaderPath', LibPath, ...
     'ImplementationSourcePath', LibPath, ...
     'AdditionalIncludePaths',   {LibPath}, ...
     'GenCallback',              'RTW.copyFileToBuildDir', ...
     'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.
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function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
     'Key',                      'RTW_OP_ADD', ...
     'Priority',                 30, ...
     'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
     'ImplementationName',       'matrix_sum_2x2_double', ...
     'ImplementationHeaderFile', 'MatrixMath.h', ...
     'ImplementationSourceFile', 'MatrixMath.c', ...
     'ImplementationHeaderPath', LibPath, ...
     'ImplementationSourcePath', LibPath, ...
     'AdditionalIncludePaths',   {LibPath}, ...
     'GenCallback',              'RTW.copyFileToBuildDir', ...
     'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);

%% Create the Implementation Representation
arg = getTflArgFromString(hTable, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', ['double' '*']);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', ['double' '*']);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'y1', ['double' '*']);

arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.addArgument(arg);
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%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_small_matrix

9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for small matrix operator to processor’;
this(1).TableList = {'crl_table_small_matrix.m'}; 
% table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations

10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Generate Code to Optimize Performance of a Small Matrix Operation
for Processor-Specific Intrinsic Function
In this section, you generate code using the code replacement library that you created in the first two
sections of this example. A nonscalar small matrix multiplication operation is replaced with a call to a
custom function in the generated code. This example does not provide an implementation of the
custom function. Write your own implementation.

Example Model

Open the model crl_SmallMatrixOperation for configuring the code replacement library.

open_system('crl_SmallMatrixOperation');

copyfile SmallMatrixOperatorTargetInfo.txt rtwTargetInfo.m
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Run the MATLAB customization file to create a code replacement table and register the file. The
customization file has already been executed. Run the sl_refresh_customizations function to register
the library.

sl_refresh_customizations;

Enable Code Replacement Library

1 Open the Configuration Parameters dialog box.
2 On the Interface pane, set Code Replacement Library by clicking Select and adding CRL for

small matrix operator to the Selected code replacement libraries - prioritized list
pane. Alternatively, use the command-line API to enable the code replacement:

set_param('crl_SmallMatrixOperation', 'CodeReplacementLibrary', 'CRL for small matrix operator');

Generate code from the model:

evalc('slbuild(''crl_SmallMatrixOperation'')');

View the generated code. Here is a portion of crl_SmallMatrixOperation.c.

cfile = fullfile('crl_SmallMatrixOperation_ert_rtw','crl_SmallMatrixOperation.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void crl_SmallMatrixOperation_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Sum: '<Root>/Add'
   */
  matrix_sum_2x2_double(&crl_SmallMatrixOperation_U.In1[0],
                        &crl_SmallMatrixOperation_U.In2[0],
                        &crl_SmallMatrixOperation_Y.Out1[0]);
}

The matrix multiplication operation on 2X2 matrices are replaced with the
matrix_sum_2x2_double function.

Close the model and code generation report.
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delete ./rtwTargetInfo.m
bdclose('crl_SmallMatrixOperation');
rtwdemoclean;

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Scalar Operator Code Replacement” on page 67-129
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Remap Operator Output to Function Input
If your generated code must meet a specific coding pattern or you want more flexibility, for example,
to further improve performance, you can remap operator outputs to input positions in an
implementation function argument list.

Note Remapping outputs to implementation function inputs is supported only for operator
replacement.

For example, for a sum operation, the code generator produces code similar to:

add8_Y.Out1 = u8_add_u8_u8(add8_U.In1, add8_U.In2);

If you remap the output to the first input, the code generator produces code similar to:

u8_add_u8_u8(&add8_Y.Out1;, add8_U.In1, add8_U.In2);

The following table definition file for a sum operation remaps operator output y1 as the first function
input argument.

1 Create a table definition file that contains a function definition. For example:

function hTable = crl_table_add_uint8
2 Within the function body, create the table by calling the function RTW.TflTable.

hTable = RTW.TflTable;
3 Create an entry for the operator mapping with a call to the RTW.TflCOperationEntry

function.

% Create operation entry 
op_entry = RTW.TflCOperationEntry;

4 Set operator entry parameters with a call to the setTflCOperationEntryParameters
function. In the function call, set the property SideEffects to true.
setTflCOperationEntryParameters(op_entry, ...
                    'Key',                      'RTW_OP_ADD', ...
                    'Priority',                 90, ...
                    'ImplementationName',       'u8_add_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_add_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_add_u8_u8.c', ...
                    'SideEffects',              true );

5 Create conceptual arguments y1, u1, and u2. There are multiple ways to set up the conceptual
arguments. This example uses calls to the getTflArgFromString and addConceptualArg
functions to create and add the arguments.
arg = getTflArgFromString(hTable, 'y1', 'uint8');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(op_entry, arg);

arg = getTflArgFromString(hTable, 'u1', 'uint8');
addConceptualArg(op_entry, arg );

arg = getTflArgFromString(hTable, 'u2', 'uint8');
addConceptualArg(op_entry, arg );

6 Create the implementation arguments. There are multiple ways to set up the implementation
arguments. This example uses calls to the getTflArgFromString function to create the
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arguments. When defining the implementation function return argument, create a new void
output argument, for example, y2. When defining the implementation function argument for the
conceptual output argument (y1), set the operator output argument as an additional input
argument. Mark its IOType as output. Make its type a pointer type. The convenience methods
setReturn and addArgument specify whether an argument is a return value or argument and
adds the argument to the entry’s array of implementation arguments.
% Create new void output y2
arg = getTflArgFromString(hTable, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
op_entry.Implementation.setReturn(arg);

% Set y1 as first input arg, mark IOType as output, and use pointer type
arg=getTflArgFromString(hTable, 'y1', 'uint8*');
arg.IOType = 'RTW_IO_OUTPUT';
op_entry.Implementation.addArgument(arg);

arg=getTflArgFromString(hTable, 'u1', 'uint8');
op_entry.Implementation.addArgument(arg);

arg=getTflArgFromString(hTable, 'u2', 'uint8');
op_entry.Implementation.addArgument(arg);

7 Add the entry to a code replacement table with a call to the addEntry function.

addEntry(hTable, op_entry);
8 Save the table definition file. Use the name of the table definition function to name the file.

To test this example:

1 Register the code replacement mapping.
2 Create a model that includes an Add block.

3 Configure the model with the following settings:

• On the Solver pane, select a fixed-step solver.
• On the Code Generation pane, select an ERT-based system target file.
• On the Code Generation > Interface pane, select the code replacement library that

contains your addition operation entry.
• Set the Optimize global data access parameter to Use global to hold temporary

results to reduce data copies in the generated code.
4 Generate code and a code generation report.
5 Review the code replacements.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Define Code Replacement Library Optimizations” on page 67-36
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• “Develop a Code Replacement Library” on page 67-20
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Fixed-Point Operator Code Replacement
If you have a Fixed-Point Designer license, you can define fixed-point operator code replacement
entries to match:

• A binary-point-only scaling combination on the operator inputs and output.
• A slope bias scaling combination on the operator inputs and output.
• Relative scaling or net slope between multiplication or division operator inputs and output. Use

one of these methods to map a range of slope and bias values to a replacement function for
multiplication or division.

• Equal slope and zero net bias across addition or subtraction operator inputs and output. Use this
method to disregard specific slope and bias values and map relative slope and bias values to a
replacement function for addition or subtraction.

Common Ways to Match Fixed-Point Operator Entries
The following table maps common ways to match fixed-point operator code replacement entries with
the associated fixed-point parameters that you specify in a code replacement table definition file.

Match Create entry Minimally specify parameters
A specific binary-point-only
scaling combination on the
operator inputs and output.

RTW.TflCOperationEntry createAndAddConceptualArg function:

• CheckSlope: Specify the value true.
• CheckBias: Specify the value true.
• DataTypeMode (or DataType/Scaling

equivalent): Specify fixed-point binary-
point-only scaling.

• FractionLength: Specify a fraction
length (for example, 3).

A specific slope bias scaling
combination on the operator
inputs and output.

RTW.TflCOperationEntry createAndAddConceptualArg function:

• CheckSlope: Specify the value true.
• CheckBias: Specify the value true.
• DataTypeMode (or DataType/Scaling

equivalent): Specify fixed-point [slope
bias] scaling.

• Slope (or SlopeAdjustmentFactor/ ‐
FixedExponent equivalent): Specify a
slope value (for example, 15).

• Bias: Specify a bias value (for example,
2).
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Match Create entry Minimally specify parameters
Net slope between operator
inputs and output
(multiplication and division).

RTW.TflCOperationEntry‐
Generator_NetSlope

setTflCOperationEntryParameters
function:

• NetSlopeAdjustmentFactor: Specify
the slope adjustment factor (F) part of
the net slope, F2E (for example, 1.0).

• NetFixedExponent: Specify the fixed
exponent (E) part of the net slope, F2E
(for example, -3.0).

createAndAddConceptualArg function:

• CheckSlope: Specify the value false.
• CheckBias: Specify the value false.
• DataType: Specify the value 'Fixed'.

Relative scaling between
operator inputs and output
(multiplication and division).

RTW.TflCOperationEntry‐
Generator

setTflCOperationEntryParameters
function:

• RelativeScalingFactorF: Specify the
slope adjustment factor (F) part of the
relative scaling factor, F2E (for example,
1.0).

• RelativeScalingFactorE: Specify the
fixed exponent (E) part of the relative
scaling factor, F2E (for example, -3.0).

createAndAddConceptualArg function:

• CheckSlope: Specify the value false.
• CheckBias: Specify the value false.
• DataType: Specify the value 'Fixed'.

Equal slope and zero net bias
across operator inputs and
output (addition and
subtraction).

RTW.TflCOperationEntry‐
Generator

setTflCOperationEntryParameters
function:

• SlopesMustBeTheSame: Specify the
value true.

• MustHaveZeroNetBias: Specify the
value true.

createAndAddConceptualArg function:

• CheckSlope: Specify the value false.
• CheckBias: Specify the value false.

Fixed-Point Numbers and Arithmetic
Fixed-point numbers use integers and integer arithmetic to represent real numbers and arithmetic
with the following encoding scheme:
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V = V = SQ + B

• V is an arbitrarily precise real-world value.
• V is the approximate real-world value that results from fixed-point representation.
• Q is an integer that encodes V, referred to as the quantized integer.
• S is a coefficient of Q, referred to as the slope.
• B is an additive correction, referred to as the bias.

The general equation for an operation between fixed-point operands is:

SOQO + BO = S1Q1 + B1 < op > (S2Q2 + B2)

The objective of fixed-point operator replacement is to replace an operator that accepts and returns
fixed-point or integer inputs and output with a function that accepts and returns built-in C numeric
data types. The following sections provide additional programming information for each supported
operator.

Addition
The operation V0 = V1 + V2 implies that

Q0 =
S1
S0

Q1 +
S2
S0

Q2 +
B1 + B2− B0

S0

If an addition replacement function is defined such that the scaling on the operands and sum are
equal and the net bias

B1 + B2− B0
S0

is zero (for example, a function s8_add_s8_s8 that adds two signed 8-bit values and produces a
signed 8-bit result), then the operator entry must set the operator entry parameters
SlopesMustBeTheSame and MustHaveZeroNetBias to true. To match for replacement, the slopes
must be the same for all addition conceptual arguments. (For parameter descriptions, see the
reference page for the function setTflCOperationEntryParameters.)

Subtraction
The operation V0 = V1 − V2 implies that

Q0 =
S1
S0

Q1−
S2
S0

Q2 +
B1− B2− B0

S0

If a subtraction replacement function is defined such that the scaling on the operands and difference
are equal and the net bias

B1− B2− B0
S0

is zero (for example, a function s8_sub_s8_s8 that subtracts two signed 8-bit values and produces a
signed 8-bit result), then the operator entry must set the operator entry parameters
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SlopesMustBeTheSame and MustHaveZeroNetBias to true. To match for replacement, the slopes
must be the same for all subtraction conceptual arguments. (For parameter descriptions, see the
reference page for the function setTflCOperationEntryParameters.)

Multiplication
There are different ways to specify multiplication replacements. The most direct way is to specify an
exact match of the input and output types. This is feasible if a model contains only a few known slope
and bias combinations. Use the TflCOperationEntry class and specify the exact values of slope
and bias on each argument. For scenarios where there are numerous slope/bias combinations, it is
not feasible to specify each value with a different entry. Use a net slope entry or create a custom
entry.

The operation V0 = V1 * V2 implies, for binary-point-only scaling, that

S0Q0 = S1Q1 S2Q2

Q0 =
S1S2
S0

Q1Q2

Q0 = SnQ1Q2

where Sn is the net slope.

It is common to replace all multiplication operations that have a net slope of 1.0 with a function that
performs C-style multiplication. For example, to replace all signed 8-bit multiplications that have a
net scaling of 1.0 with the s8_mul_s8_u8_ replacement function, the operator entry must define a
net slope factor, F2E. You specify the values for F and E using operator entry parameters
NetSlopeAdjustmentFactor and NetFixedExponent. For the s8_mul_s8_u8 function, set
NetSlopeAdjustmentFactor to 1 and NetFixedExponent to 0.0. Also, set the operator entry
parameter SlopesMustBeTheSame to false and the parameter MustHaveZeroNetBias to true.
To match for replacement, the biases must be zero for all multiplication conceptual arguments. (For
parameter descriptions, see the reference page for the function
setTflCOperationEntryParameters.)

Note When an operator entry specifies NetSlopeAdjustmentFactor and NetFixedExponent,
matching entries must have arguments with zero bias.

Division
There are different ways to specify division replacements. The most direct way is to specify an exact
match of the input and output types. This is feasible if a model contains only a few known slope and
bias combinations. Use the TflCOperationEntry class and specify the exact values of slope and
bias on each argument. For scenarios where there are numerous slope/bias combinations, it is not
feasible to specify each value with a different entry. Use a net slope entry or create a custom entry
(see “Customize Match and Replacement Process” on page 67-118).

The operation V0 = (V1 / V2) implies, for binary-point-only scaling, that

S0Q0 =
S1Q1
S2Q2

Q0 = Sn
Q1
Q2
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where Sn is the net slope.

It is common to replace all division operations that have a net slope of 1.0 with a function that
performs C-style division. For example, to replace all signed 8-bit divisions that have a net scaling of
1.0 with the s8_mul_s8_u8_ replacement function, the operator entry must define a net slope factor,
F2E. You specify the values for F and E using operator entry parameters
NetSlopeAdjustmentFactor and NetFixedExponent. For the s16_netslope0p5_div_s16_s16
function, you would set NetSlopeAdjustmentFactor to 1 and NetFixedExponent to 0.0. Also, set
the operator entry parameter SlopesMustBeTheSame to false and the parameter
MustHaveZeroNetBias to true. To match for replacement, the biases must be zero for all division
conceptual arguments. (For parameter descriptions, see the reference page for the function
setTflCOperationEntryParameters.)

Note When an operator entry specifies NetSlopeAdjustmentFactor and NetFixedExponent,
matching entries must have arguments with zero bias.

Data Type Conversion (Cast)
The data type conversion operation V0 = V1 implies, for binary-point-only scaling, that

Q0 =
S1
S0

Q1

Q0 = SnQ1

where Sn is the net slope. Set the operator entry parameter SlopesMustBeTheSame to false and
the parameter MustHaveZeroNetBias to true. To match for replacement, the biases must be zero
for all cast conceptual arguments. (For parameter descriptions, see the reference page for the
function setTflCOperationEntryParameters.)

Shift
The shift left or shift right operation V0 = (V1 / 2n) implies, for binary-point-only scaling, that

S0Q0 =
S1Q1

2n

Q0 =
S1
S0

Q1

2n

Q0 = Sn
Q1

2n

where Sn is the net slope. Set the operator entry parameter SlopesMustBeTheSame to false and
the parameter MustHaveZeroNetBias to true. To match for replacement, the biases must be zero
for all shift conceptual arguments. (For parameter descriptions, see the reference page for the
function setTflCOperationEntryParameters.)
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See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Define Code Replacement Library Optimizations” on page 67-36
• “Binary-Point-Only Scaling Code Replacement” on page 67-175
• “Slope Bias Scaling Code Replacement” on page 67-180
• “Net Slope Scaling Code Replacement” on page 67-186
• “Equal Slope and Zero Net Bias Code Replacement” on page 67-193
• “Data Type Conversions (Casts) and Operator Code Replacement” on page 67-199
• “Shift Left Operations and Code Replacement” on page 67-205
• “Data Alignment for Code Replacement” on page 67-97
• “Remap Operator Output to Function Input” on page 67-166
• “Customize Match and Replacement Process” on page 67-118
• “Develop a Code Replacement Library” on page 67-20
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Binary-Point-Only Scaling Code Replacement
You can define code replacement entries for operations on fixed-point data types such that they match
a binary-point-only scaling combination of operator inputs and output. This example shows how to
develop a code replacement library to optimize the performance of fixed point data type operations by
providing information that maps a binary point scale entry to a addition operator. To develop a code
replacement library use only the programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 67-20.

This example modifies a fixed-point addition replacement such that the implementation function
passes in the fraction lengths of the input and output data types as arguments.

To create custom code replacement entries that add logic to the code replacement match and
replacement process see “Customize Code Match and Replacement for Scalar Operations” on page
67-124. You can create and add three additional implementation function arguments for passing
fraction lengths in the class definition or in each code replacement entry definition that instantiates
this class. This example creates the arguments, adds them to a code replacement table definition file,
and sets them to specific values in the class definition code.
classdef TflCustomOperationEntryBinaryPoint < RTW.TflCOperationEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok

      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This class will check additional data and can
      % modify the implementation function.

      % The base class checks word size and signedness. Slopes and biases
      % have been wildcarded, so the only additional checking to do is
      % to check that the biases are zero and that there are only three
      % conceptual arguments (one output, two inputs)

      ent = []; % default the return to empty, indicating the match failed

      if length(hCSO.ConceptualArgs) == 3 && ...
          hCSO.ConceptualArgs(1).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(2).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(3).Type.Bias == 0

        % Modify the default implementation. Since this is a
        % generator entry, a concrete entry is created using this entry
        % as a template. The type of entry being created is a standard
        % TflCOperationEntry. Using the standard operation entry
        % provides required information, and you do not need
        % a custom match function.
        ent = RTW.TflCOperationEntry(hThis);

        % Since this entry is modifying the implementation for specific
        % fraction-length values (arguments 3, 4, and 5), the conceptual argument
        % wild cards must be removed (the wildcards were inherited from the
        % generator when it was used as a template for the concrete entry).
        % This concrete entry is now for a specific slope and bias. 
        % hCSO holds the slope and bias values (created by the code generator).
        for idx=1:3
          ent.ConceptualArgs(idx).CheckSlope = true;
          ent.ConceptualArgs(idx).CheckBias = true;

          % Set the specific Slope and Biases
          ent.ConceptualArgs(idx).Type.Slope = hCSO.ConceptualArgs(idx).Type.Slope;
          ent.ConceptualArgs(idx).Type.Bias = 0;
        end

        % Set the fraction-length values in the implementation function.
        ent.Implementation.Arguments(3).Value = ...
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           -1.0*hCSO.ConceptualArgs(2).Type.FixedExponent;
        ent.Implementation.Arguments(4).Value = ...
           -1.0*hCSO.ConceptualArgs(3).Type.FixedExponent;
        ent.Implementation.Arguments(5).Value = ...
           -1.0*hCSO.ConceptualArgs(1).Type.FixedExponent;
      end
    end
  end
end

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_fixed_binptscale()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the custom entry function .

function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.

function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_binarypoint', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.
function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_binarypoint', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'BinaryPoint', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'BinaryPoint', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'BinaryPoint', ...
       'IsSigned',   false, ...
       'WordLength', 32);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
createAndSetCImplementationReturn and createAndAddImplementationArg. Add the
complete entry to the table by calling the function addEntry.
function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_binarypoint', ...
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    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'BinaryPoint', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'BinaryPoint', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'BinaryPoint', ...
       'IsSigned',   false, ...
       'WordLength', 32);

%% Create the implementation Representation
% Specify replacement function signature
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 3 fraction-length args. Actual values are set during code generation.
createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_out', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);
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%% Add the entry to the table
hTable.addEntry(op_entry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_fixed_binptscale
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for binary point scaling CRL’;
this(1).TableList = {'crl_table_fixed_binptscale.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Fixed-Point Operator Code Replacement” on page 67-169
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Slope Bias Scaling Code Replacement
You can define code replacement for operations on fixed-point data types as matching a slope bias
scaling combination on the operator inputs and output. This example shows how to develop a code
replacement library to optimize the performance of fixed point data type operations by providing
information on how to define code replacement for a division operator. To develop a code
replacement library use only the programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 67-20.

This example modifies a fixed-point addition replacement such that the implementation function
passes in the fraction lengths of the input and output data types as arguments.

To create custom code replacement entries that add logic to the code replacement match and
replacement process, see “Customize Code Match and Replacement for Scalar Operations” on page
67-124. You can create and add three additional implementation function arguments for passing
fraction lengths in the class definition or in each code replacement entry definition that instantiates
this class. This example creates the arguments, adds them to a code replacement table definition file,
and sets them to specific values in the class definition code.
classdef TflCustomOperationEntrySlopeBias < RTW.TflCOperationEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok

      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This class will check additional data and can
      % modify the implementation function.

      % The base class checks word size and signedness. Slopes and biases
      % have been wildcarded, so the only additional checking to do is
      % to check that the biases are zero and that there are only three
      % conceptual arguments (one output, two inputs)

      ent = []; % default the return to empty, indicating the match failed

      if length(hCSO.ConceptualArgs) == 3

        % Modify the default implementation. Since this is a
        % generator entry, a concrete entry is created using this entry
        % as a template. The type of entry being created is a standard
        % TflCOperationEntry. Using the standard operation entry
        % provides required information, and you do not need
        % a custom match function.
        ent = RTW.TflCOperationEntry(hThis);

        % Since this entry is modifying the implementation for specific
        % fraction-length values (arguments 3, 4, and 5), the conceptual argument
        % wild cards must be removed (the wildcards were inherited from the
        % generator when it was used as a template for the concrete entry).
        % This concrete entry is now for a specific slope and bias. 
        % hCSO holds the slope and bias values (created by the code generator).
        for idx=1:3
          ent.ConceptualArgs(idx).CheckSlope = true;
          ent.ConceptualArgs(idx).CheckBias = true;

          % Set the specific Slope and Biases
          ent.ConceptualArgs(idx).Type.Slope = hCSO.ConceptualArgs(idx).Type.Slope;
          ent.ConceptualArgs(idx).Type.Bias = hCSO.ConceptualArgs(idx).Type.Bias;
        end

        % Set the Slope and Bias values in the implementation function.
        ent.Implementation.Arguments(3).Value = hCSO.ConceptualArgs(2).Type.Slope;
        ent.Implementation.Arguments(4).Value = hCSO.ConceptualArgs(2).Type.Bias;
        ent.Implementation.Arguments(5).Value = hCSO.ConceptualArgs(3).Type.Slope;
        ent.Implementation.Arguments(6).Value = hCSO.ConceptualArgs(3).Type.Bias;
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        ent.Implementation.Arguments(7).Value = hCSO.ConceptualArgs(1).Type.Slope;
        ent.Implementation.Arguments(8).Value = hCSO.ConceptualArgs(1).Type.Bias;
      end
    end
  end
end

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the custom entry function .

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_slopebias', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_slopebias', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'SlopeBias', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'SlopeBias', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'SlopeBias', ...
       'IsSigned',   false, ...
       'WordLength', 32);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
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createAndSetCImplementationReturn and createAndAddImplementationArg. Add the
complete entry to the table by calling the function addEntry.
function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_slopebias', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'SlopeBias', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'SlopeBias', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'SlopeBias', ...
       'IsSigned',   false, ...
       'WordLength', 32);

%% Create the implementation Representation
% Specify replacement function signature
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 3 fraction-length args. Actual values are set during code generation.
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
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    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 6 args for slopes and biases. 
% Actual values are set during code generation.
createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'slope_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'bias_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   true, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'slope_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'bias_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   true, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'slope_out1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'bias_out1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   true, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_custom_add_ufix32_slopebias
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9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for slope bias scaling function replacement’;
this(1).TableList = {'crl_table_custom_add_ufix32_slopebias.m'}; 
% table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Fixed-Point Operator Code Replacement” on page 67-169
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Net Slope Scaling Code Replacement
You can define code replacement entries for multiplication and division operations on fixed-point data
types such that they match the net slope between operator inputs and output. The net slope entries
can map a range of slope and bias values to a replacement function for multiplication or division.

This example shows how to develop a code replacement library to optimize the performance of fixed
point net slope operations by providing information on how to define code replacement for a divide
operation. To develop a code replacement library use either the interactive or programmatic
approach. For more information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_netslopeScaling. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Fixed Point Net
Slope Operation.

4 Create entry parameters. In the Operation drop-down list, select Divide.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of
fixdt(true,16,*,*) and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. In the Function arguments subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of int
16. Also set the Net slope Adjustment Factor as 1 and Net Fixed Exponent as 0.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
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more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntryGenerator_NetSlope.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

4 Set operator entry parameters with a call to the setTflCOperationEntryParameters
function. The parameters specify the type of operation as division, the saturation mode as wrap
on overflow, rounding modes as unspecified, and the name of the replacement function as
user_div_*. NetSlopeAdjustmentFactor and NetFixedExponent specify the F and E parts
of the net slope F2E.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
   'Key',                      'RTW_OP_DIV', ...
   'Priority',                 90, ...
   'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
   'RoundingModes',            {'RTW_ROUND_CEILING'}, ...
   'NetSlopeAdjustmentFactor',   1.0, ...
   'NetFixedExponent',           0.0, ...
   'ImplementationName',       's16_div_s16_s16', ...
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   'ImplementationHeaderFile', 's16_div_s16_s16.h', ...
   'ImplementationSourceFile', 's16_div_s16_s16.c');

5 Create conceptual arguments y1, u1, and u2. This example uses calls to the
createAndAddConceptualArg function to create and add an argument with one function call.
Specify each argument as fixed-point, 16 bits, and signed. Also, for each argument, specify that
code replacement request processing does not check for an exact match to the call-site slope and
bias values.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
   'Key',                      'RTW_OP_DIV', ...
   'Priority',                 90, ...
   'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
   'RoundingModes',            {'RTW_ROUND_CEILING'}, ...
   'NetSlopeAdjustmentFactor',   1.0, ...
   'NetFixedExponent',           0.0, ...
   'ImplementationName',       's16_div_s16_s16', ...
   'ImplementationHeaderFile', 's16_div_s16_s16.h', ...
   'ImplementationSourceFile', 's16_div_s16_s16.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'y1', ...
   'IOType',         'RTW_IO_OUTPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u1', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u2', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);
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6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. This example uses calls to the
createAndSetCImplementationReturn and createAndAddImplementationArg functions
to create and add implementation arguments to the entry. Implementation arguments must
describe fundamental numeric data types (not fixed-point data types). In this case, the output and
input arguments are 16 bits and signed (int16).

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
   'Key',                      'RTW_OP_DIV', ...
   'Priority',                 90, ...
   'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
   'RoundingModes',            {'RTW_ROUND_CEILING'}, ...
   'NetSlopeAdjustmentFactor',   1.0, ...
   'NetFixedExponent',           0.0, ...
   'ImplementationName',       's16_div_s16_s16', ...
   'ImplementationHeaderFile', 's16_div_s16_s16.h', ...
   'ImplementationSourceFile', 's16_div_s16_s16.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'y1', ...
   'IOType',         'RTW_IO_OUTPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u1', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u2', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

%% Create the Implementation Representation
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createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
                              'Name',           'y1', ...
                              'IOType',         'RTW_IO_OUTPUT', ...
                              'IsSigned',       true, ...
                              'WordLength',     16, ...
                              'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
                              'Name',           'u1', ...
                              'IOType',         'RTW_IO_INPUT', ...
                              'IsSigned',       true, ...
                              'WordLength',     16, ...
                              'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
                              'Name',           'u2', ...
                              'IOType',         'RTW_IO_INPUT', ...
                              'IsSigned',       true, ...
                              'WordLength',     16, ...
                              'FractionLength', 0);

%% Add the entry to the table
addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_netslopeScaling
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for net slope scaling’;
this(1).TableList = {'crl_table_netslopeScaling.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.
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See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Fixed-Point Operator Code Replacement” on page 67-169
• “Equal Slope and Zero Net Bias Code Replacement” on page 67-193
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Equal Slope and Zero Net Bias Code Replacement
You can define code replacement entries for addition or subtraction of fixed-point data types such
that they match the relative slope and bias values (equal slope and zero net bias) across operator
inputs and output. These entries allow you to disregard slope and bias values when mapping relative
slope and bias values to a replacement function for addition or subtraction.

This example shows how to develop a code replacement library to optimize the performance of fixed
point net slope operations by providing information on how to define code replacement for an
addition operation. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_equal_slope_netbias_add. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Fixed Point Net
Slope Operation.

4 Create entry parameters. In the Operation drop-down list, select Addition.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of
fixdt(true,16,*,*) and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. In the Function arguments subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of int
16.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
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10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntryGenerator_NetSlope.

function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.

function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                     'RTW_OP_ADD', ...
    'Priority',                 90, ...
    'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
    'SlopesMustBeTheSame',      true, ...
    'MustHaveZeroNetBias',      true, ...
    'ImplementationName',       'u16_add_SameSlopeZeroBias', ...
    'ImplementationHeaderFile', 'u16_add_SameSlopeZeroBias.h', ...
    'ImplementationSourceFile', 'u16_add_SameSlopeZeroBias.c');
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5 Create conceptual arguments y1, u1, and u2. This example uses calls to the
createAndAddConceptualArg function to create and add an argument with one function call.
Specify each argument as fixed-point, 16 bits, and signed. Also, for each argument, specify that
code replacement request processing does not check for an exact match to the call-site slope and
bias values.
function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                     'RTW_OP_ADD', ...
    'Priority',                 90, ...
    'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
    'SlopesMustBeTheSame',      true, ...
    'MustHaveZeroNetBias',      true, ...
    'ImplementationName',       'u16_add_SameSlopeZeroBias', ...
    'ImplementationHeaderFile', 'u16_add_SameSlopeZeroBias.h', ...
    'ImplementationSourceFile', 'u16_add_SameSlopeZeroBias.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'y1', ...
    'IOType',         'RTW_IO_OUTPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u1', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u2', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. This example uses calls to the
createAndSetCImplementationReturn function to create and add implementation
arguments to the entry. Implementation arguments must describe fundamental numeric data
types (not fixed-point data types). In this case, the output and input arguments are 16 bits and
signed (int16).
function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                     'RTW_OP_ADD', ...
    'Priority',                 90, ...
    'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
    'SlopesMustBeTheSame',      true, ...
    'MustHaveZeroNetBias',      true, ...
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    'ImplementationName',       'u16_add_SameSlopeZeroBias', ...
    'ImplementationHeaderFile', 'u16_add_SameSlopeZeroBias.h', ...
    'ImplementationSourceFile', 'u16_add_SameSlopeZeroBias.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'y1', ...
    'IOType',         'RTW_IO_OUTPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u1', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u2', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

%% Create the Implementation Representation
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'y1', ...
    'IOType',         'RTW_IO_OUTPUT', ...
    'IsSigned',       false, ...
    'WordLength',     16, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
    'Name',           'u1', ...
    'IOType',         'RTW_IO_INPUT', ...
    'IsSigned',       false, ...
    'WordLength',     16, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
    'Name',           'u2', ...
    'IOType',         'RTW_IO_INPUT', ...
    'IsSigned',       false, ...
    'WordLength',     16, ...
    'FractionLength', 0);

%% Add the entry to the table
addEntry(hTable, hEntry); 

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_equal_slope_netbias_add
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for equal slope and zero net bias code replacement’;
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this(1).TableList = {'crl_table_equal_slope_netbias_add.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Fixed-Point Operator Code Replacement” on page 67-169
• “Net Slope Scaling Code Replacement” on page 67-186
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Data Type Conversions (Casts) and Operator Code
Replacement

You can use code replacement entries to replace code that the code generator produces for data type
conversion (cast) operations. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), at the MATLAB command line, enter:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_cast_int32_to_int16. Click Apply.

3 Create entry parameters. In the Operation drop-down list, select Cast.
4 Create an entry. From the crtool context menu, select File > New entry > Fixed Point Net

Slope Operation.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1 with the Data Type of int16 , and the input argument, u1 with
the Data Type of int32 and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. In the Function
arguments subsection of the crtool, specify the return argument, y1, and the input argument,
u1 with the Data Type of int16 and int32.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_cast_int32_to_int16()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
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%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.The parameters specify the type of
operation as cast, the saturation mode as saturate on integer overflow, rounding modes as
toward negative infinity, and the name of the replacement function as my_sat_cast.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                      'RTW_OP_CAST', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_sat_cast', ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                      'RTW_OP_CAST', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_sat_cast', ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual representation

arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
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same order and properties as the conceptual arguments, call the function
getTflArgFromString. Add the complete entry to the table by calling the function addEntry.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                      'RTW_OP_CAST', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_sat_cast', ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual and implementation representation

arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', 'int32');
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
addEntry(hTable,hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_cast_int32_to_int16
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for data type conversions(casts) abd operator code replacement’;
this(1).TableList = {'crl_table_cast_int32_to_int16.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Fixed-Point Operator Code Replacement” on page 67-169
• “Net Slope Scaling Code Replacement” on page 67-186
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Shift Left Operations and Code Replacement
This example shows how to develop a code replacement library to optimize the performance of shift
left (<<) operation by providing information on how to define code replacement for a shift left
function. To develop a code replacement library use either the interactive or programmatic approach.
For more information, see “Develop a Code Replacement Library” on page 67-20.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_shift_left_int16. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Operator drop-down list, select Shift Left.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input arguments, u1, and u2, with Data Type of int16
and the Argument Type of scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Under Function prototypespecify a Name for the replacement function.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.

 Shift Left Operations and Code Replacement

67-205



9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
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10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_shift_left_int16
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTable = crl_table_shift_left_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this example replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_shift_left_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_SL', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_shift_left', ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString and addConceptualArg .
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function hTable = crl_table_shift_left_int16()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_SL', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_shift_left', ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual representation
arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', 'int16');
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', 'int16');
arg.CheckType = false;
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = crl_table_shift_left_int16()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_SL', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_shift_left', ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual and implementation representation
arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', 'int16');
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', 'int16');
arg.CheckType = false;
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);
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%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_shift_left_int16
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) by using these specifications.
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for shift left operation’;
this(1).TableList = {'crl_table_shift_left_int16.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Addition and Subtraction Operator Code Replacement” on page 67-134
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Optimize Generated Code by Using Multiple Code Replacement
Libraries

You can generate code that has code replacements enabled by multiple code replacement libraries.
You can select multiple Code Replacement libraries in a unified workflow so that the generated code
contains optimizations from varied code replacement libraries such as AUTOSAR 4.0 and Intel
SSE. You can also select your own custom code replacement libraries along with libraries included
with Embedded Coder to further optimize the generated code. You can select and use a combination
of libraries and achieve the requisite functionalities, and need not author separate libraries. In
instances where there are multiple custom code replacement libraries and you need functionalities
from all of them, individually select the libraries.

Example Model

This example shows how to replace the generated code for a model containing an Add block and an
Abs block by using multiple code replacement libraries. You replace the Abs block using a code
replacement customization that replaces the regular fabs function with the custom implementation
CRL_abs_d from the ScalarFcn library. The Add block has inputs of size [50 50]. The loops in the
generated code are vectorized with SIMD capabilities supported by the Intel AVX library.

Open the model mMultiLibrary_abs that has an Add block and an Abs block.

model = 'mMultiLibrary_abs';
open_system(model);

copyfile multipleFnRtwTargetInfo.txt rtwTargetInfo.m

The MATLAB customization files hcrl_make_abs and hcrl_sum_float have already been
executed. Run the sl_refresh_customizations function to register the library ScalarFcn.

sl_refresh_customizations;

Select Code Replacement Librarie
1 Open the Configuration Parameters dialog box.
2 In the Configuration Parameters dialog box, set the correct Device Vendor and Device Type

depending on the hardware target. In this example Intel is the Device Vendor and
x86-64(Windows64) is the Device Type.

3 On the Interface pane, set Code Replacement Library parameter by clicking Select and
adding the code replacement libraries to the Selected code replacement libraries -
prioritized list pane. For this example, choose Intel SSE (Windows) and ScalarFcn. The
ScalarFcn library works on the Windows platforms. Linux users must supply a different library.

4 Order the code replacement libraries according to the priority in which you want to see them
replaced in the generated code. Code replacement libraries at the top of order have a higher
priority during code replacement.
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Alternatively, use the command-line API to enable the code replacement:

set_param('mMultiLibrary_abs','CodeReplacementLibrary','Intel SSE (Windows),ScalarFcn')

Generate code for the model.

evalc('slbuild(model)');

NOTE: When registering a code replacement library, you cannot use a comma in the code
replacement library name.

View the generated code with the replacements. Here is a portion of mMultiLibrary_abs.c.
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cfile = fullfile('mMultiLibrary_abs_ert_rtw','mMultiLibrary_abs.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void mMultiLibrary_abs_step(void)
{
  int32_T i;

  /* Outport: '<Root>/Out1' incorporates:
   *  Abs: '<Root>/Abs1'
   *  Inport: '<Root>/In1'
   */
  mMultiLibrary_abs_Y.Out1 = CRL_abs_d(mMultiLibrary_abs_U.In1);
  for (i = 0; i <= 2498; i += 2) {
    /* Outport: '<Root>/Output' incorporates:
     *  Inport: '<Root>/In2'
     *  Inport: '<Root>/In3'
     */
    _mm_storeu_pd(&mMultiLibrary_abs_Y.Output[i], _mm_add_pd(_mm_loadu_pd
      (&mMultiLibrary_abs_U.In2[i]), _mm_loadu_pd(&mMultiLibrary_abs_U.In3[i])));
  }
}

The generated code contains the CRL_abs_d function enabled by the custom code replacement
library ScalarFcn. Note that this library only works for Windows. The for-loop utilizes SIMD
functionality through the function _mm_add_pd enabled by the Intel SSE (Windows) code
replacement library. Selecting multiple code replacement libraries enables multiple optimizations in
the generated code.

Close the model and code generation report.

delete ./rtwTargetInfo.m
bdclose(model)
rtwdemoclean;

Limitations:

• When you use multiple Intel SIMD code replacement libraries, the priority ordering is ignored.
Intel AVX512 has a higher priority than AVX, which has higher priority over SSE, regardless of the
order specified by the code replacement library.

• When you use different argument types such as matrix and scalar, the priority ordering is ignored.
A matrix code replacement library has a higher priority than a scalar code replacement library,
regardless of the order specified by the code replacement library.

• When the code replacement library parameter specifies a Standard Math Library, for instance
through its BaseTfl, and it does not match the Standard Math Library parameter, the library
specified by the Standard Math Library parameter is used.

See Also

More About
• “Code replacement libraries”
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• “Develop a Code Replacement Library” on page 67-20
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
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Code Replacement Customization for
MATLAB Code

• “What Is Code Replacement Customization?” on page 68-3
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Develop a Code Replacement Library” on page 68-13
• “Quick Start Library Development” on page 68-14
• “Identify Code Replacement Library Requirements” on page 68-21
• “Define Code Replacement Library Optimizations” on page 68-23
• “Register Code Replacement Library” on page 68-38
• “Troubleshoot Code Replacement Library Registration” on page 68-42
• “Verify Code Replacement Library” on page 68-43
• “Troubleshoot Code Replacement Misses” on page 68-47
• “Deploy Code Replacement Library” on page 68-50
• “Math Function Code Replacement” on page 68-51
• “Memory Function Code Replacement” on page 68-57
• “Specify In-Place Code Replacement” on page 68-62
• “Data Alignment for Code Replacement” on page 68-67
• “Array Layout and Code Replacement” on page 68-73
• “Allow Shape Agnostic Match” on page 68-75
• “Replace MATLAB Functions with Custom Code by Using the coder.replace Function”

on page 68-79
• “Replace coder.ceval Calls to External Functions” on page 68-85
• “Reserved Identifiers and Code Replacement” on page 68-92
• “Customize Match and Replacement Process” on page 68-93
• “Scalar Operator Code Replacement” on page 68-99
• “Addition and Subtraction Operator Code Replacement” on page 68-104
• “Small Matrix Operation to Processor Code Replacement” on page 68-111
• “Matrix Multiplication Operation to MathWorks BLAS Code Replacement” on page 68-117
• “Matrix Multiplication Operation to ANSI/ISO C BLAS Code Replacement” on page 68-125
• “Remap Operator Output to Function Input” on page 68-132
• “Fixed-Point Operator Code Replacement” on page 68-134
• “Binary-Point-Only Scaling Code Replacement” on page 68-140
• “Slope Bias Scaling Code Replacement” on page 68-145
• “Net Slope Scaling Code Replacement” on page 68-151
• “Equal Slope and Zero Net Bias Code Replacement” on page 68-158
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• “Data Type Conversions (Casts) and Operator Code Replacement” on page 68-164
• “Shift Left Operations and Code Replacement” on page 68-170
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - MATLAB®”

on page 68-175

68 Code Replacement Customization for MATLAB Code

68-2



What Is Code Replacement Customization?
Customize how and when the code generator replaces C/C++ code that it generates by default for
functions and operators by developing a custom code replacement library. You can develop libraries
interactively with the Code Replacement Tool or programmatically.

• Develop libraries tailored to specific application requirements
• Add identifiers to the list of reserved keywords the code generator considers during code

replacement
• Customize the code generator’s match and replacement process for functions

To get started, “Quick Start Code Replacement Library Development - Simulink®” on page 67-21.

Code Replacement Match and Replacement Process
When the code generator encounters a call site for a function or operator, it:

1 Creates and partially populates a code replacement entry object with the function or operator
name or key and conceptual arguments.

2 Uses the entry object to query the configured code replacement library for a conceptual
representation match. The code generator searches the tables in a code replacement library for a
match in the order that the tables appear in the library. When searching for a match, the code
generator takes into account:

• Conceptual name or key
• Arguments, including quantity, type, type qualifiers, and complexity
• Algorithm (computation method)
• Fixed-point saturation and rounding modes
• Priority

3 When a match exists, the code generator returns a code replacement object, fully populated with
the conceptual representation, implementation representation, and priority. If the code generator
finds multiple matches within a table, the entry priority determines the match. The priority can
range from 0 to 100. The highest priority is 0. The code generator uses a higher-priority entry
over a similar entry with a lower priority.

4 Uses the C or C++ replacement function prototype in the code replacement object to generate
code.

Code Replacement Customization Limitations
• Code replacement verification — It is possible that code replacement behaves differently than you

expect. For example, data types that you observe in code generator input might not match what
the code generator uses as intermediate data types during an operation. Verify code replacements
by examining generated code. See “Verify Code Replacement Library” on page 68-43.

• Tokens in file paths—You can include tokens in file paths when specifying build information for a
code replacement entry by using the programming interface only. The ability to include tokens is
not available from the Code Replacement Tool. See Specify build information in “Define Code
Replacement Library Optimizations” on page 68-23.

• Addition and subtraction operation replacements—See “Addition and Subtraction Operator Code
Replacement” on page 68-104 for relevant limitations.
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• coder.replace function — See coder.replace for relevant limitations.
• coder.dataAlignment function — See coder.dataAlignment for relevant limitations.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Develop a Code Replacement Library” on page 68-13
• “Quick Start Library Development” on page 68-14
• “What Is Code Replacement?”
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Code You Can Replace from MATLAB Code
Code that the code generator replaces depends on the code replacement library (CRL) that you use.
By default, the code generator does not apply a code replacement library. Your choice of libraries is
dependent on product licensing and whether you have access to custom libraries.

In this section...
“Math Functions” on page 68-5
“Memory Functions” on page 68-8
“Operators” on page 68-9

Math Functions
When generating C/C++ code from MATLAB code, depending on code replacement libraries available
in your development environment, you can configure the code generator to replace instances of the
following math functions with application-specific implementations.

Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

abs1 Floating point Scalar Real
acos Floating point Scalar

Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

acosd Floating point Scalar
Vector
Matrix

Real
Complex

acot Floating point Scalar
Vector
Matrix

Real
Complex

acotd Floating point Scalar
Vector
Matrix

Real
Complex

acoth Floating point Scalar
Vector
Matrix

Real
Complex

acsc Floating point Scalar
Vector
Matrix

Real
Complex

acscd Floating point Scalar
Vector
Matrix

Real
Complex

acsch Floating point Scalar
Vector
Matrix

Real
Complex
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

asec Floating point Scalar
Vector
Matrix

Real
Complex

asecd Floating point Scalar
Vector
Matrix

Real
Complex

asech Floating point Scalar
Vector
Matrix

Real
Complex

asin Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

asind Floating point Scalar
Vector
Matrix

Real
Complex

atan Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

atan2 Floating point Scalar
Vector
Matrix

Real

atan2d Floating point Scalar
Vector
Matrix

Real

atand Floating point Scalar
Vector
Matrix

Real
Complex

cos Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

ceil • Floating-point
• Scalar

• Floating-point
• Scalar

• Floating-point
• Scalar

cosd Floating point Scalar
Vector
Matrix

Real
Complex

cosh Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

cot Floating point Scalar
Vector
Matrix

Real
Complex

cotd Floating point Scalar
Vector
Matrix

Real
Complex

coth Floating point Scalar
Vector
Matrix

Real
Complex

csc Floating point Scalar
Vector
Matrix

Real
Complex

cscd Floating point Scalar
Vector
Matrix

Real
Complex

csch Floating point Scalar
Vector
Matrix

Real
Complex

exp Floating point Scalar Real
fix Floating point Scalar Real
floor • Floating-point

• Scalar
• Floating-point
• Scalar

• Floating-point
• Scalar

hypot Floating point Scalar
Vector
Matrix

Real

ldexp Floating point Scalar Real
log Floating point Scalar

Vector
Matrix

Real
Complex

log10 Floating point Scalar
Vector
Matrix

Real
Complex

log2 Floating point Scalar
Vector
Matrix

Real
Complex

max Integer
Floating point

Scalar Real

min Integer
Floating point

Scalar Real

pow Floating point Scalar Real
rem Floating point Scalar Real
round Floating point Scalar Real
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

sec Floating point Scalar
Vector
Matrix

Real
Complex

secd Floating point Scalar
Vector
Matrix

Real
Complex

sech Floating point Scalar
Vector
Matrix

Real
Complex

sign Floating point Scalar Real
sin Floating point Scalar

Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

sind Floating point Scalar
Vector
Matrix

Real
Complex

sinh Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

sqrt Floating point Scalar Real
tan Floating point Scalar

Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

tand Floating point Scalar
Vector
Matrix

Real
Complex

tanh Floating point Scalar
Vector
Matrix

Real
Complex
Complex input/complex output
Real input/complex output

1 Wrap on integer overflow only

Memory Functions
Depending on code replacement libraries available in your development environment, you can
configure the code generator to replace instances of the following memory functions with application-
specific implementations.
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Function Data Type Support Scalar, Vector, Matrix
Support

Real, Complex Support

memcmp Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

memcpy Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

memset Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

memset2zero Void pointer (void*) Scalar
Vector
Matrix

Real
Complex

Some target processors provide optimized functions to set memory to zero. Use the code replacement
library programming interface to replace the memset2zero function with more efficient target-
specific functions.

Operators
When generating C/C++ code from MATLAB code, depending on code replacement libraries available
in your development environment, you can configure the code generator to replace instances of the
following operators with application-specific implementations.

Mixed data type support indicates you can specify different data types of different inputs.

Operator Key Data Type
Support

Scalar, Vector,
Matrix Support

Real,
Complex
Support

Addition (+)1 RTW_OP_ADD Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Subtraction (-)1 RTW_OP_MINUS Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Multiplication (*)2 RTW_OP_MUL Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Division (/) RTW_OP_DIV Integer
Floating point
Fixed-point
Mixed

Scalar Real
Complex
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Operator Key Data Type
Support

Scalar, Vector,
Matrix Support

Real,
Complex
Support

Data type
conversion (cast)

RTW_OP_CAST Integer
Floating point3

Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Shift left (<<) RTW_OP_SL Integer
Fixed-point
Mixed

Scalar
Vector
Matrix

Real

Shift right
arithmetic (>>)4

RTW_OP_SRA Integer
Fixed-point
Mixed

Scalar
Vector
Matrix

Real

Shift right logical
(>>)

RTW_OP_SRL Integer
Fixed-point
Mixed

Scalar
Vector
Matrix

Real

Element-wise
matrix
multiplication (.*)5

RTW_OP_ELEM_MUL Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Complex
conjugation

RTW_OP_CONJUGATE Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Transposition (.') RTW_OP_TRANS Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Hermitian (complex
conjugate)
transposition (')

RTW_OP_HERMITIAN Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Multiplication with
transposition2

RTW_OP_TRMUL Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Multiplication with
Hermitian
transposition2

RTW_OP_HMMUL Integer
Floating point
Fixed-point
Mixed

Vector
Matrix

Real
Complex

Multiplication
followed by shift
right arithmetic
(u1*u2>>u3)6

RTW_OP_MUL_SRA Integer
Fixed-point

Scalar Real

Multiplication
followed by division
(u1*u2/u3)7

RTW_OP_MULDIV Integer
Fixed-point

Scalar Real
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Operator Key Data Type
Support

Scalar, Vector,
Matrix Support

Real,
Complex
Support

Greater than (>) RTW_OP_GREATER_
THAN

Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Greater than or
equal (>=)

RTW_OP_GREATER_
THAN_OR_EQUAL

Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Less than (<) RTW_OP_LESS_THAN Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Less than or equal
(<=)

RTW_OP_LESS_THAN_
OR_EUQAL

Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Equal (==) RTW_OP_EUQAL Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

Not equal (!=) RTW_OP_NOT_EUQAL Integer
Floating point
Fixed-point
Mixed

Scalar
Vector
Matrix

Real
Complex

1 See “Addition and Subtraction Operator Code Replacement” on page 68-104 for details to consider
when defining mappings for addition and subtraction code replacements.

2 Can map to Basic Linear Algebra Subroutine (BLAS) multiplication functions.

3 Scaled floating point is not supported.

4 Code replacement libraries that provide arithmetic shift right implementations should also provide
logical shift right implementations, because some arithmetic shift rights are converted to logical
shift rights during code generation.

5 Use the multiplication (*) operator (RTW_OP_MUL) for scalar multiplication.

6 Requires scalar, real, or fixed-point data types with zero bias; output type of the multiplication
operation to accommodate all possible output values; shift operand is an unsigned integer; and net
slope is equal to 1 (U1_slope * U2_slope == Mul_output_slope and Mul_output_slope ==
output_slope_of_shift_operation).

7 Requires scalar, real, or fixed-point data types with zero bias; output type of the multiplication
operation to accommodate all possible output values; and net slope is equal to 1 (U1_slope *
U2_slope == Mul_output_slope == U3_slope * Div_output_slope).
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See Also

More About
• “Develop a Code Replacement Library” on page 68-13
• “Quick Start Library Development” on page 68-14
• “What Is Code Replacement?”
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Develop a Code Replacement Library
Iterate through the following steps, as necessary, to develop a code replacement library:

1 “Identify Code Replacement Library Requirements” on page 68-21
2 “Define Code Replacement Library Optimizations” on page 68-23
3 “Register Code Replacement Library” on page 68-38
4 “Verify Code Replacement Library” on page 68-43
5 “Deploy Code Replacement Library” on page 68-50

To get started, see “Identify Code Replacement Library Requirements” on page 68-21.

To experiment with the process and tools, see “Quick Start Library Development” on page 68-14.

See Also

More About
• “Identify Code Replacement Library Requirements” on page 68-21
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Quick Start Library Development” on page 68-14
• “What Is Code Replacement Customization?” on page 68-3
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Quick Start Library Development
This example shows how to develop a code replacement library that includes an entry for generating
replacement code for the math function sin. You use the Code Replacement Tool.

Prerequisites

To complete this example, install the following software:

• MATLAB
• MATLAB Coder
• Embedded Coder
• C compiler

For instructions on installing MathWorks products, see “Installation and Licensing”. If you have
installed MATLAB and want to see what other MathWorks products are installed, in the Command
Window, enter ver.

For a list of supported compilers, see https://www.mathworks.com/support/compilers/
current_release/.

Open the Code Replacement Tool

1 Start a new MATLAB session.
2 Create or navigate (cd) to an empty folder.
3 At the command prompt, enter the crtool command. The Code Replacement Tool window

opens.

Create Code Replacement Table

1 In the Code Replacement Tool window, select File > New table.
2 In the right pane, name the table crl_table_sinfcn and click Apply. Later, when you save the

table, the tool saves it with the file name crl_table_sinfcn.m.
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Create Table Entry

Create a table entry that maps a sin function with double input and double output to a custom
implementation function.

1 In the left pane, select table crl_table_sinfcn. Then, select File > New entry > Function.
The new entry appears in the middle pane, initially without a name.

2 In the middle pane, select the new entry.
3 In the right pane, on the Mapping Information tab, from the Function menu, select sin.
4 Leave Algorithm set to Unspecified, and leave parameters in the Conceptual function group

set to default values.
5 In the Replacement function group, name the replacement function sin_dbl.
6 Leave the remaining parameters in the Replacement function group set to default values.
7 Click Apply. The tool updates the Function signature preview to reflect the specified

replacement function name.
8 Scroll to the bottom of the Mapping Information tab and click Validate entry. The tool

validates your entry.

The following figure shows the completed mapping information.
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Specify Build Information for Replacement Code

1 On the Build Information tab, for the Implementation header file parameter, enter
sin_dbl.h.

2 Leave the remaining parameters set to default values.
3 Click Apply.
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4 Optionally, you can revalidate the entry. Return to the Mapping Information tab and click
Validate entry.

Create Another Table Entry

Create an entry that maps a sin function with single input and double output to a custom
implementation function named sin_sgl. Create the entry by copying and pasting the sin_dbl
entry.

1 In the middle pane, select the sin_dbl entry.
2 Select Edit > Copy
3 Select Edit > Paste
4 On the Mapping Information tab, in the Conceptual function section, set the data type of

input argument u1 to single.
5 In the Replacement function section, name the function sin_sgl. Set the data type of input

argument u1 to single.
6 Click Apply. Note the changes that appear for the Function signature preview.
7 On the Build Information tab, for the Implementation header file parameter, enter

sin_sgl.h. Leave the remaining parameters set to default values and click Apply.

Validate the Code Replacement Table

1 Select Actions > Validate table.
2 If the tool reports errors, fix them, and rerun the validation. Repeat fixing and validating errors

until the tool does not report errors. The following figure shows a validation report.

Save the Code Replacement Table

Save the code replacement table to a MATLAB file in your working folder. Select File > Save table.
By default, the tool uses the table name to name the file. For this example, the tool saves the table in
the file crl_table_sinfcn.m.

Review the Code Replacement Table Definition

Consider reviewing the MATLAB code for your code replacement table definition. After using the tool
to create an initial version of a table definition file, you can update, enhance, or copy the file in a text
editor.

To review it, in MATLAB or another text editor, open the file crl_table_sinfcn.m.

Generate a Registration File

Before you can use your code replacement table, you must register it as part of a code replacement
library. Use the Code Replacement Tool to generate a registration file.

1 In the Code Replacement Tool, select File > Generate registration file.
2 In the Generate registration file dialog box, edit the dialog box fields to match the following

figure, and then click OK.
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3 In the Select location to save the registration file dialog box, specify a location for the
registration file. The location must be on the MATLAB path or in the current working folder. Save
the file. The tool saves the file as rtwTargetInfo.m.

Register the Code Replacement Table

At the command prompt, enter:

RTW.TargetRegistry.getInstance('reset');

Review and Test Code Replacements

Apply your code replacement library. Verify that the code generator makes code replacements that
you expect.

1 Check for errors. At the command line, invoke the table definition file. For example:

If an error exists in the definition file, the invocation triggers a message to appear. Fix the error
and try again.

tbl = crl_table_sinfcn

tbl =

TflTable with properties:
               Version: '1.0'
       ReservedSymbols: []
   StringResolutionMap: []
            AllEntries: [2x1 RTW.TflCFunctionEntry]
           EnableTrace: 1|

2 Use the Code Replacement Viewer to check your code replacement entries. For example:

crviewer('Sin Function Example')

In the viewer, select entries in your table and verify that the content is what you expect. The
viewer can help you detect issues such as:

• Incorrect argument order.
• Conceptual argument names that do not match what is expected by the code generator.
• Incorrect priority settings.

3 Identify existing or create new MATLAB code that calls the sin function. For example:

function y = my_sin_fnc(x)
  y = sin(x);
end
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4 Open the MATLAB Coder app.
5 Add the function that includes a call to the sin function as an entry-point file. For example, add

my_sin_func.m. The app creates a project named my_sin_func.prj.
6 Click Next to go to the Define Input Type step. Define the types for the entry-point function

inputs.
7 Click Next to go to the Check for Run-Time Issues step. This step is optional. However, it is a

best practice to perform this step. Provide a test file that calls your entry-point function. The app
generates a MEX function from your entry-point function. Then, the app runs the test file,
replacing calls to the MATLAB function with calls to the generated MEX function.

8 Click Next to go to the Generate Code step. To open the Generate dialog box, click the
Generate arrow .

9 Set Build type to generate a library or executable.
10 Click More Settings.
11 Configure the code generator to use your code replacement library. On the Custom Code tab,

set the Code replacement library parameter to the name of your library. For example, Sin
Function Example.

12 Configure the code generation report. On the Debug tab, set the Always create a report, Code
replacements, and Automatically launch a report if one is generated parameters.

13 Configure the code generator to generate code only. For Build type, select Source code. You
want to review your code replacements in the generated code before building an executable.

14 Click Generate to generate C code and a report.
15 Review code replacement results in the Code Replacements Report section of the code

generation report.

The report indicates that the code generator found a match and applied the replacement code for
the function sin_dbl.

16 Review the code replacements. In the report, click the MATLAB function that triggered the
replacement, my_sin_func.m. The MATLAB Editor opens and highlights the function call that
triggers the code replacement.

See Also

More About
• “Develop a Code Replacement Library” on page 68-13
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• “What Is Code Replacement Customization?” on page 68-3
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Identify Code Replacement Library Requirements

What Is a Code Replacement Library?
A code replacement library defines optimizations for generated C or C++ code from Simulink models
or MATLAB code for specific targets. You can configure the code generator to use your code
replacement library to replace specified functions in your model or MATLAB code with optimized
implementations.

What Functions Can Be Optimized with a Code Replacement Library?
You can use a code replacement library to optimize the performance of functions defined either by
Simulink models or MATLAB code. To look up functions that are available to optimize, see “Code You
Can Replace From Simulink Models” on page 67-6 and “Code You Can Replace from MATLAB Code”
on page 68-5.

How to Develop a Code Replacement Library
You can develop a code replacement library either interactively, using the Code Replacement Tool
(crtool), or programmatically, using the MATLAB programming interface. The Code Replacement Tool
is quick, easy, and ideal for first time library development, while the MATLAB Programming interface
provides more customization and control options. To determine which approach to use, identify your
use case below:

Interactive Approach:

• Developing a code replacement library for the first time
• Rapid prototyping

Programmatic Approach:

• Specifying code replacement attributes not available with the Code Replacement Tool
• Creating or modifying code replacement library entries by copying, pasting, and editing
• Modifying a registration file by copying and pasting content

Identify Basic Requirements
• What model or MATLAB code do you want to optimize by using a code replacement library?
• What functions and operations within your model or MATLAB code do you want to replace? What

is the signature for each function or operation that you want to replace?
• What build files (source, header, object) do you need to provide to the code generator?

See Also

More About
• “Develop a Code Replacement Library” on page 68-13
• “What Is Code Replacement Customization?” on page 68-3
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• “Code You Can Replace from MATLAB Code” on page 68-5
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Define Code Replacement Library Optimizations
A code replacement library contains one or more code replacement tables. Each table contains one or
more code replacement entries. Each entry contains a mapping and entry parameters. The entry
maps the conceptual representation of an automatically generated MATLAB or Simulink function to
an implementation representation of an optimized C or C++ function. The entry parameters describe
additional properties for the code generator to honor during code replacement.

To define a code replacement library, first define code replacement tables in a customization file.
Then, during the registration step, create a code replacement library by selecting tables to include in
your library. You can define your code replacement tables both interactively or programmatically
using the same work flow.

The interactive and programmatic approaches both follow these 8 steps:

1 Open the environment.
2 Create a table.
3 Create an entry.
4 Create entry parameters.
5 Create the conceptual representation.
6 Create the implementation representation.
7 Specify build information.
8 Validate and save.

Interactively Develop a Code Replacement Library
1 Open the environment.

To interactively create a code replacement library, open the Code Replacement Tool (crtool)
from the MATLAB command line with the command:
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>> crtool 
2 Create a table.

A code replacement table organizes code replacement entries into groupings that are easier to
manage.

To create a code replacement table:

a From the crtool menu, select File > New table.
b In the right pane, name the table and click Apply.

3 Create an entry.

A code replacement table entry contains entry parameters and a mapping of a conceptual
representation that describes a generated function to an implementation representation that
describes an optimized implementation of that function.

To create a code replacement entry, use one of these methods:

• From the crtool toolbar, click the entry-type icon the select the entry-type.
• From the crtool menu, select File > New entry > entry-type.
• Right-click on a table and select New entry > entry-type.

The new entry appears without a name in the middle pane.
4 Create entry parameters.

Entry parameters specify optimization and build requirements for the code generator to honor
during code replacement. These parameters vary and automatically appear in various sections of
the crtool interface depending on the type of function replacement.

To create entry parameters:

• In the Function or Operation drop-down list, select the name of the function you want to
replace.

This selection determines the entry parameters that appear in the crtool.
5 Create the conceptual representation.

The conceptual representation describes the signature of the function you want to replace. The
conceptual representation consists of the function name, return arguments, and parameters. The
return arguments are referred to as output arguments, and the parameters are referred to as
input arguments. Specify each conceptual argument with a name, I/O type, and, depending on
the type of replacement, other properties that appear in the crtool.

To define your conceptual representation:

• In the Conceptual Function or Conceptual Operation subsection of the crtool, specify the
input and output arguments of the function you want the code generator to replace.

6 Create the implementation representation.

The implementation representation describes the signature of the replacement function defined
in the code replacement library. The implementation representation consists of a function name,
return arguments, and parameters. Specify each implementation argument with a type, type
qualifier, and complexity.
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To define your implementation representation:

• In the Implementation Function or Operation Function subsection of the crtool, specify
the input and output arguments for the optimized function defined in the code replacement
library.

7 Specify build information.

Build information provides the code generator with the files to perform function replacement.

To specify build information:

• In the crtool, click the Build Information tab to open the build requirements pane. Specify
necessary build information in these fields:

Parameter Description
Implementation header file Name of header file needed for code

replacement.
Implementation source file Name of source file needed for code

replacement.
Additional header files/include paths Name and path of additional header files

needed for code replacement.
Additional source files/paths Name and path of additional source files

needed for code replacement.
Additional object files/paths Name and path of additional object files

needed for code replacement.
Additional link flags Flags the linker needs to generate an

executable file for the replacement code.
Additional compile flags Flags the compiler needs to generate object

code for the replacement code.
Copy files to build directory Flags whether to copy header, source, or

object files, which are required to generate
replacement code, to the build folder before
code generation. If you specify files with
Additional header files/include paths or
Additional source files/ paths and you
copy files, the compiler and utilities such as
packNGo might find duplicate instances of
files.

8 Validate and save.

Save your code replacement library with the same name as your code replacement table on your
MATLAB path. Saving your library automatically validates unvalidated content.

To validate and save your library:

• From the crtool menu, select File > Save Table > Save.
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Programmatically Develop a Code Replacement Library
1 Open the environment.

To programmatically create a code replacement library, open a MATLAB function file. From the
MATLAB menu select New > Function.

2 Create a table.

A code replacement table organizes code replacement entries into groupings that are easier to
manage.

To create a code replacement table:

a Create a function you can use to call your code replacement library table. The function
should not have arguments and return a table object.

b Create a table object with a call to RTW.TflTable.

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;
 
end

3 Create an entry.

A code replacement table entry contains entry parameters and a mapping of a conceptual
representation of a generated function to the implementation representation of an optimized
implementation of that function.

To create a code replacement table:

a Identify the type of function you want to replace.
b Call the corresponding Entry Function to create an entry in your table.

Type of Function You Want to Replace Entry Function
Math Operation RTW.TflCOperationEntry
Function RTW.TflCFunctionEntry
BLAS operation RTW.TflBlasEntryGenerator
CBLAS operation RTW.TflCBlasEntryGenerator
Fixed-point addition and subtraction
operations

RTW.TflCOperationEntryGenerator

Net slope fixed-point operation RTW.TflCOperationEntryGenerator_Ne
tSlope

Semaphore or mutex RTW.TflCSemaphoreEntry
Custom function RTW.TflCFunctionEntryML
Custom operation RTW.TflCOperationEntryML

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table
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%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

end
4 Create entry parameters.

Entry parameters specify optimization and build requirements for the code generator to honor
during code replacement. These parameters vary depending on the type of function replacement.

To create your entry parameters:

• Call the Set Parameters function that corresponds with the type of function you want to
replace identified in the previous step (step 3).

Type of Function You Want to Replace Set Parameters function
Math operation, BLAS operation, CBLAS
operation, Fixed-Point, Net Slope Fixed-
Point, Custom operation

setTflCOperationEntryParameters

Function, Custom function setTflCFunctionEntryParameters
Semaphore or Mutex setTflCSemaphoreEntryParameters

Each Set Parameter function is shown with all available properties set to their default values.
The exact properties and values you need to specify depends on the function you replace. See
examples for specific replacement details.

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

 Define Code Replacement Library Optimizations

68-27



%% Create entry parameters
% Pick one from list below
hEntry.setTflCOperationEntryParameters(...        
        'Key',                          ' ', ...
        'Priority',                     100, ...
        'AcceptExprInput',              true, ...
        'AdditionalHeaderFiles',        {}, ...
        'AdditionalIncludePaths',       {}, ...
        'AdditionalLinkObjs',           {}, ...
        'AdditionalLinkObjsPaths',      {}, ...
        'AdditionalSourceFiles',        {}, ...
        'AdditionalSourcePaths',        {}, ...
        'AdditionalCompileFlags',       {}, ...
        'AdditionalLinkFlags',          {}, ...
        'AllowShapeAgnostic',           false, ...
        'ArrayLayout',                  'COLUMN_MAJOR', ...
        'EntryInfoAlgorithm',           'RTW_CAST_BEFORE_OP', ...
        'GenCallback',                  ' ', ...
        'ImplementationHeaderFile',     ' ', ...
        'ImplementationHeaderPath',     ' ', ...
        'ImplementationName',           ' ', ...
        'ImplementationSourceFile',     ' ', ...
        'ImplementationSourcePath',     ' ', ...
        'ImplType',                     'FCN_IMPL_FUNCT', ...
        'MustHaveZeroNetBias',          false, ...
        'NetFixedExponet',              0, ...
        'NetAdjustmentFactor', 1,       ...
        'RoundingModes',                'RTW_ROUND_UNSPECIFIED', ...
        'SaturationMode',               'RTW_SATURATE_UNSPECIFIED', ...
        'SideEffects',                  false, ...
        'SlopesMustBeTheSame',          false, ...
        'StoreFcnReturnInLocalVar',     false);
    
hEntry.setTflCFunctionEntryParameters(...
        'Key',                          ' ', ...
        'Priority',                     100, ...
        'AcceptExprInput',              true, ...
        'AdditionalHeaderFiles',        {}, ...
        'AdditionalIncludePaths',       {}, ...
        'AdditionalLinkObjs',           {}, ...
        'AdditionalLinkObjsPaths',      {}, ...
        'AdditionalSourceFiles',        {}, ...
        'AdditionalSourcePaths',        {}, ...
        'AdditionalCompileFlags',       {}, ...
        'AdditionalLinkFlags',          {}, ...
        'ArrayLayout',                  'COLUMN_MAJOR', ...
        'EntryInfoAlgorithm',           'RTW_DEFAULT', ...
        'GenCallback',                  ' ', ...
        'ImplementationHeaderFile',     ' ', ...
        'ImplementationHeaderPath',     ' ', ...
        'ImplementationName',           ' ', ...
        'ImplementationSourceFile',     ' ', ...
        'ImplementationSourcePath',     ' ', ...
        'ImplType',                     'FCN_IMPL_FUNCT', ...
        'RoundingModes',                'RTW_ROUND_UNSPECIFIED', ...
        'SaturationMode',               'RTW_SATURATE_UNSPECIFIED', ...
        'SideEffects',                  false, ...
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        'StoreFcnReturnInLocalVar',     false);
    
hEntry.setTflCSemaphoreEntryParameters(...       
        'Key',                          ' ', ...
        'Priority',                     100, ...
        'AcceptExprInput',              true, ...
        'AdditionalHeaderFiles',        {}, ...
        'AdditionalIncludePaths',       {}, ...
        'AdditionalLinkObjs',           {}, ...
        'AdditionalLinkObjsPaths',      {}, ...
        'AdditionalSourceFiles',        {}, ...
        'AdditionalSourcePaths',        {}, ...
        'AdditionalCompileFlags',       {}, ...
        'AdditionalLinkFlags',          {}, ....
        'GenCallback',                  ' ', ...
        'ImplementationHeaderFile',     ' ', ...
        'ImplementationHeaderPath',     ' ', ...
        'ImplementationName',           ' ', ...
        'ImplementationSourceFile',     ' ', ...
        'ImplementationSourcePath',     ' ', ...
        'ImplType',                     'FCN_IMPL_FUNCT', ...
        'RoundingModes',                'RTW_ROUND_UNSPECIFIED', ...
        'SaturationMode',               'RTW_SATURATE_UNSPECIFIED', ...
        'SideEffects',                  false, ...
        'StoreFcnReturnInLocalVar',     false);
 
end

5 Create the conceptual representation.

The conceptual representation describes the signature of the function you want to replace. It
consists of the function name, return arguments, and parameters. The return arguments are
referred to as output arguments, and the parameters are referred to as input arguments. Specify
each conceptual argument with the required properties, and, depending on the type of
replacement, other optional properties.

Required properties:

• Name- Defined as y1..yn for output arguments and u1..un for input arguments
• I/O type- Defined as RTW_IO_OUTPUT or RTW_IO_INPUT

To define your conceptual representation, use one of these approaches:

Approach Function Goal
1 createAndAddConceptual

Arg
Customization and control.

If you want to explicitly specify arguments as
scalar or matrix and other properties.

2 getTflArgFromString Rapid prototyping.

If you want to quickly specify arguments with
built-in data types.

Programming approaches are shown with all available properties set to default values. The exact
properties and values you need to specify depends on the function you replace. See examples for
specific replacement details.
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function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

%% Create entry parameters
% Pick one from list below
% To view properties, see step 4 
hEntry.setTflCOperationEntryParameters( );
hEntry.setTflCFunctionEntryParameters( );
hEntry.setTflCSemaphoreEntryParameters( );

%% Create the conceptual representation

% Approach 1: createAndAddConceptualArg
% arg = createAndAddConceptualArg(hEntry, argType, varargin)
% argType - 'RTW.TflArgNumeric' | 'RTW.TflArgMatrix'
% varargin - 'name', 'value' pairs shown below set to default values,
% includes name and I/O type

% Define Output Arguments
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'y1', ... 
        'IOType',                       'RTW_IO_OUTPUT', ... 
        'IsSigned',                     true, ...
        'WordLength',                   32, ...
        'CheckSlope',                   true, ...
        'CheckBias',                    true, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'BaseType',                     'double', ...
        'DimRange',                     [2,2]);

% Define Input Arguments
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'u1', ...
        'IOType',                       'RTW_IO_OUTPUT', ...
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        'IsSigned',                     true, ...
        'WordLength',                   32, ...
        'CheckSlope',                   true, ...
        'CheckBias',                    true, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'BaseType',                     'double', ...
        'DimRange',                     [2,2]);

% Approach 2: getTflArgFromString
% arg = getTflArgFromString(hEntry, name, I/O type)
% name- y1..yn | u1..un
% I/O type- RTW_IO_OUTPUT | RTW_IO_INPUT

% Define Output Arguments
arg = getTflArgFromString('y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);

% Define Input Arguments
arg = getTflArgFromString('u1', 'double');
arg.IOType = 'RTW_IO_INPUT';
hEntry.addConceptualArg(arg);

end
6 Create the implementation representation.

The implementation representation describes the signature of the replacement function defined
by the code replacement library. It consists of the function name, return arguments, and
parameters. Specify the implementation arguments with a type, type qualifier, and complexity.
After you define your implementation representation, add your completed entry to the code
replacement table with a call to the function addEntry.

To define your implementation representation, use one of these approaches:

Approach Function Goal
1 copyConceptualArgsToImplem

entation
Identical arguments.

Specify implementation arguments and
conceptual arguments have the same
properties.

2 createAndAddImplementation
Arg
createAndSetCImplementatio
nReturn

Same order, different properties.

Specify implementation arguments have
the same order as conceptual arguments
but have different properties.
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Approach Function Goal
3 getTflArgFromString Add constant value.

Specify implementation arguments with a
constant value.

4 getTflDWorkFromString Mutex/Semaphore replacement.

Specify implementation arguments for
mutex or semaphore functions.

5 createCRLEntry Create entry with one function.

Declare and define a code replacement
table entry (conceptual and
implementation arguments) in one
function.

Programming approaches are shown with all available properties set to their default values. The
exact properties and values you need to specify depends on the function you replace. See
examples for specific replacement details.

function hTable = code_replacement_library_table()
% Create a function to call code replacement library table

%% Create a code replacement library table object
hTable = RTW.TflTable;

%% Create a code replacement library entry
% Pick one from list below
hEntry = RTW.TFLCOperationEntry;
hEntry = RTW.TflCFunctionEntry;
hEntry = RTW.TflBlasEntryGenerator;
hEntry = RTW.TflCBlasEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator;
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;
hEntry = RTW.TflCSemaphoreEntry;
hEntry = RTW.TflCFunctionEntryML;
hEntry = RTW.TflCOperationEntryML;

%% Create entry parameters
% Pick one from list below
% To view properties, see step 4
hEntry.setTflCOperationEntryParameters( );
hEntry.setTflCFunctionEntryParameters( );
hEntry.setTflCSemaphoreEntryParameters( );

%% Create the conceptual representation

% Approach 1: createAndAddConceptualArg
% arg = createAndAddConceptualArg(hEntry, argType, varargin)
% argType - 'RTW.TflArgNumeric' | 'RTW.TflArgMatrix'
% varargin - 'name', 'value' pairs shown below set to default values,
% includes name and I/O type, to view properties, see step 5

% Define Output Arguments
hEntry.createAndAddConceptualArg( );
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% Define Input Arguments
hEntry.createAndAddConceptualArg( );

% Approach 2: getTflArgFromString
% arg = getTflArgFromString(hEntry, name, I/O type)
% name- y1..yn | u1..un
% I/O type- RTW_IO_OUTPUT | RTW_IO_INPUT

% Define Output Arguments
arg = getTflArgFromString('y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);

% Define Input Arguments
arg = getTflArgFromString('u1', 'double');
arg.IOType = 'RTW_IO_INPUT';
hEntry.addConceptualArg(arg);

%% Create the implementation representation

% Approach 1: copyConceptualArgsToImplementation
copyConceptualArgsToImplementation(hEntry);

% Approach 2: createAndSetCImplementation, createAndSetCImplementationArg
% arg = createAndAddImplementation(hEntry, argType,varargin),
% arg = createAndSetCImplementationReturn(hEntry, argType,varargin)
% argType - 'RTW.TflArgNumeric' | 'RTW.TflArgMatrix'
% varargin - 'name', 'value' pairs shown below set to default values,
% includes name and I/O type

% Define Output Arguments
hEntry.createAndSetCImplementationReturn(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'y1', ...
        'IOType',                       'RTW_IO_Output', ...
        'IsSigned',                     true, ...
        'WordLength',                   16, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1.0, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'Value',                        0);
    
% Define Input Arguments
hEntry.createAndAddImplementationArg(...
        'RTW.TflArgNumeric',            ...
        'Name',                         'y1', ...
        'IOType',                       'RTW_IO_Output', ...
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        'IsSigned',                     true, ...
        'WordLength',                   16, ...
        'DataTypeMode',                 'Fixed-point:binary point scaling', ...
        'DataType',                     'Fixed', ...
        'Scaling',                      'BinaryPoint', ...
        'Slope',                        1.0, ...
        'SlopeAdjustmentFactor',        1.0, ...
        'FixedExponent',                -15, ...
        'Bias',                         0.0, ...
        'FractionLength',               15, ...
        'Value',                        0);
 

% Approach 3: getTflArgFromString
% arg = getTflArgFromString(hEntry, name, datatype)
% name- y1..yn | u1..un, datatype - built-in data type

% Define Output arguments
arg = getTflArgFromString(hEntry, 'y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg);

% Define Input arguments
arg = getTflArgFromString(hEntry, 'u1', 'double', 0);
hEntry.Implementation.addArgument(arg);

% Approach 4: getTflDWorkFromString
% arg = getTflDWorkFromString(hEntry, name, datatype)

% Define arguments
arg = getTflDWorkFromString('d1', 'void*');
hEntry.addDWorkArg(arg);

% Approach 5: createCRLEntry
% tableEntry = createCRLEntry(crTable,conceptualSpecification,implementationSpecification)

% Define code replacement conceptual and implementation arguments
hEntry = createCRLEntry(...
        hTable, ...
        'conceptualSpecification', ...
        'implementationSpecification');

%% Add code replacement library entry to table
hTable.addEntry(hEntry);

end
7 Specify build information.

Specify build information for your code replacement library. Build information provides the code
generator with the files necessary to perform function replacement.

68 Code Replacement Customization for MATLAB Code

68-34



To specify build information:

• Specify your build parameters in the Entry Parameters function you defined in step 4 or with
the specified functions. Specify build information with the following properties:

Parameter Description
Implementation header file

Set properties
ImplementationHeaderFile and
ImplementationHeaderPath.

Name of header file needed for code
replacement.

Implementation source file

Set properties
ImplementationSourceFile and
ImplementationSourcePath.

Name of source file needed for code
replacement.

Additional header files/include paths

For each file, specify the file name and path
in calls to the functions
addAdditionalHeaderFile and
addAdditionalIncludePath.

Name and path of additional header files
needed for code replacement.

Additional source files/paths

For each file, specify the file name and path
in calls to the functions
addAdditionalSourceFile and
addAdditionalSourcePath.

Name and path of additional source files
needed for code replacement.

Additional object files/paths

For each file, specify the file name and path
in calls to the functions
addAdditionalLinkObj and
addAdditionalLinkObjPath.

Name and path of additional object files
needed for code replacement.

Additional link flags

Set the entry property
AdditionalLinkFlags to a cell array of
character vectors or string array
representing the required compile flags.

Flags the linker needs to generate an
executable file for the replacement code.

Additional compile flags

Set the entry property
AdditionalCompileFlags to a cell array
of character vectors or string array
representing the required link flags.

Flags the compiler needs to generate object
code for the replacement code.
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Parameter Description
Copy files to build directory.

Set property GenCallback to
'RTW.copyFileToBuildDir'.

If a match occurs for a table entry, a call to
the function RTW.copyFileToBuildDir
copies required files to the build folder.

If you specify additional header files/include
paths or additional source files/paths and you
copy files, the compiler and utilities such as
packNGo might find duplicate instances of
files.

Flags whether to copy header, source, or
object files, which are required to generate
replacement code, to the build folder before
code generation. If you specify files with
Additional header files/include paths or
Additional source files/ paths and you
copy files, the compiler and utilities such as
packNGo might find duplicate instances of
files.

• If an entry uses header, source, or object files, consider whether to make the files accessible
to the code generator. You can copy files to the build folder or you can specify individual file
names and paths explicitly.

• If you specify additional header files/include paths or source files/paths and you copy files, the
compiler and utilities such as packNGo might find duplicate instances of files (an instance in
the build folder and an instance in the original folder).

• If you choose to copy files to the build folder and you are using the packNGo function to
relocate static and generated code files to another development environment:

• In the call to packNGo, specify the property-value pair 'minimalHeaders' true (the
default). That setting instructs the function to include the minimal header files required to
build the code in the zip file.

• Do not collocate files that you copy with files that you do not copy. If the packNGo function
finds multiple instances of the same file, the function returns an error.

• If you use the programming interface, paths that you specify can include tokens. A token is a
variable defined as a character vector, cell array of character vectors, or string array in the
MATLAB workspace that you enclose with dollar signs ($variable$). The code generator
evaluates and replaces a token with the defined value. For example, consider the path
$myfolder$\folder1, where myfolder is a character vector or string scalar variable
defined in the MATLAB workspace as 'd:\work\source\module1'. The code generator
generates the custom path as d:\work\source\module1\folder1.

8 Validate and save.

Save your code replacement library customization file with the same name as your code
replacement library table on your MATLAB path.

To save and validate your library:

a Save your file. From the MATLAB menu, select File > Save.
b Validate your library by calling it from the MATLAB command line. For example:

>> hTable = code_replacement_library_table()
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See Also

More About
• “What Is Code Replacement Customization?” on page 68-3
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Develop a Code Replacement Library” on page 68-13
• “Math Function Code Replacement” on page 68-51
• “Memory Function Code Replacement” on page 68-57
• “Specify In-Place Code Replacement” on page 68-62
• “Replace MATLAB Functions with Custom Code by Using the coder.replace Function” on page

68-79
• “Reserved Identifiers and Code Replacement” on page 68-92
• “Customize Match and Replacement Process” on page 68-93
• “Scalar Operator Code Replacement” on page 68-99
• “Addition and Subtraction Operator Code Replacement” on page 68-104
• “Small Matrix Operation to Processor Code Replacement” on page 68-111
• “Matrix Multiplication Operation to MathWorks BLAS Code Replacement” on page 68-117
• “Matrix Multiplication Operation to ANSI/ISO C BLAS Code Replacement” on page 68-125
• “Remap Operator Output to Function Input” on page 68-132
• “Customize Match and Replacement Process for Operators” on page 68-94
• “Fixed-Point Operator Code Replacement” on page 68-134
• “Binary-Point-Only Scaling Code Replacement” on page 68-140
• “Slope Bias Scaling Code Replacement” on page 68-145
• “Net Slope Scaling Code Replacement” on page 68-151
• “Equal Slope and Zero Net Bias Code Replacement” on page 68-158
• “Data Type Conversions (Casts) and Operator Code Replacement” on page 68-164
• “Shift Left Operations and Code Replacement” on page 68-170

 Define Code Replacement Library Optimizations

68-37



Register Code Replacement Library
Create a code replacement library by defining in a registration file the library name, code
replacement tables, and other information. After you define and register your library it becomes
available to the code generator for code replacement.

Interactively Develop and Load a Registration file
1 In the crtool, select File > Generate registration file.

2 In the Generate registration file dialog box, specify registration information. Then click OK.

Parameter Description
Registry name (Required) Code replacement library name.
Table list (Required) Comma-separated list of one or more code

replacement tables that you want in the
library. Specify tables by using either their
names (if located on the MATLAB search
path), absolute paths, or relative paths.

Base CRL Enables you to specify library hierarchies.
Provide the name of a registered library to
serve as a base for the library that you are
currently registering. For example, a TI
device library can be a base for a TI C28x
library.

Target HW device Comma-separated list of one or more
hardware devices that this library supports.
Indicate support of all devices with an
asterisk (*).

Description Description of the purpose and content of the
library.

Generate data alignment specification Flag that enables data alignment.
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3 To use your registered code replacement library, refresh your current MATLAB session with the
command:

>> sl_refresh_customizations

Programmatically Develop and Load a Registration File
1 Open a MATLAB function file. From the MATLAB menu, select New > Function.
2 Save the function file with the name rtwTargetInfo.m.
3 Copy and paste the following code into your file to use as a template.

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; %instantiates a registration entry
this(1).Name = 'Example Code Replacement Library';
this(1).TableList = {'example_code_replacement_table.m'};
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'This registers an example library';

end
4 In the template, specify the following registration information:

Parameter Description
Registry name (Required) Code replacement library name.
Table list (Required) Comma-separated list of one or more code

replacement tables that you want in the
library. Specify tables by using either their
names (if located on the MATLAB search
path), absolute paths, or relative paths.

Base CRL Enables you to specify library hierarchies.
Provide the name of a registered library to
serve as a base for the library that you are
currently registering. For example, a TI
device library can be a base for a TI C28x
library.

Target HW device Comma-separated list of one or more
hardware devices that this library supports.
Indicate support of all devices with an
asterisk (*).

Description Description of the purpose and content of the
library.

Generate data alignment specification Flag that enables data alignment.
5 Save the file on your MATLAB path.
6 To use your registered code replacement library, refresh your current MATLAB session with the

command:
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>> sl_refresh_customizations

Examples
Register one code replacement library

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; %instantiates a registration entry
this(1).Name = 'Example Code Replacement Library';
this(1).TableList = {'example_code_replacement_table.m'};
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'This registers an example library';

end

Register multiple code replacement libraries

function rtwTargetInfo(cm)
cm.registerTargetInfo(@loc_register_crl);
end

function thisCRL = loc_register_crl
  % Register a code replacement library for use with model: rtwdemo_crladdsub
  thisCrl(1) = RTW.TflRegistry;
  thisCrl(1).Name = 'Addition & Subtraction Examples';
  thisCrl(1).Description = 'Example of addition/subtraction op replacement';
  thisCrl(1).TableList = {'crl_table_addsub'};
  thisCrl(1).TargetHWDeviceType = {'*'};

  % Register a code replacement library for use with model: rtwdemo_crlmuldiv
  thisCrl(2) = RTW.TflRegistry;
  thisCrl(2).Name = 'Multiplication & Division Examples';
  thisCrl(2).Description = 'Example of mult/div op repl for built-in integers';
  thisCrl(2).TableList = {'c:/work_crl/crl_table_muldiv'};
  thisCrl(2).TargetHWDeviceType = {'*'};

  % Register a code replacement library for use with model: rtwdemo_crlfixpt
  thisCrl(3) = RTW.TflRegistry;
  thisCrl(3).Name = 'Fixed-Point Examples';
  thisCrl(3).Description = 'Example of fixed-point operator replacement';
  thisCrl(3).TableList = {fullfile('$(MATLAB_ROOT)', ...
     'toolbox','rtw','rtwdemos','crl_demo','crl_table_fixpt')};
   thisCrl(3).TargetHWDeviceType = {'*'};

end

Register a code replacement hierarchy

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
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function thisCRL = loc_register_crl 
  % Register a code replacement library that includes common entries
  thisCrl(1) = RTW.TflRegistry;
  thisCrl(1).Name = 'Common Replacements';
  thisCrl(1).Description = 'Common code replacement entries shared by other libraries';
  thisCrl(1).TableList = {'crl_table_general'};
  thisCrl(1).TargetHWDeviceType = {'*'};
 
  % Register a code replacement library for TI devices
  thisCrl(2) = RTW.TflRegistry;
  thisCrl(2).Name = 'TI Device Replacements';
  thisCrl(2).Description = 'Code replacement entries shared across TI devices';
  thisCrl(2).TableList = {'crl_table_TI_devices'};
  thisCrl(2).TargetHWDeviceType = {'TI C28x', 'TI C55x', 'TI C62x', 'TI C64x', 'TI 67x'};
  thisCrl(1).BaseTfl = 'Common Replacements'
 
  % Register a code replacement library for TI c6xx devices
  thisCrl(3) = RTW.TflRegistry;
  thisCrl(3).Name = 'TI c6xx Device Replacements';
  thisCrl(3).Description = 'Code replacement entries shared across TI C6xx devices';
  thisCrl(3).TableList = {'crl_table_TIC6xx_devices'};
  thisCrl(3).TargetHWDeviceType = {'TI C62x', 'TI C64x', 'TI 67x'};
 
  % Register a code replacement library for the TI c67x device
  thisCrl(4) = RTW.TflRegistry;
  thisCrl(4).Name = 'TI c67x Device Replacements';
  thisCrl(4).Description = 'Code replacement entries for the TI C67x device';
  thisCrl(4).TableList = {'crl_table_TIC67x_device'};
  thisCrl(4).TargetHWDeviceType = {'TI 67x'};

 
end

See Also

More About
• “Troubleshoot Code Replacement Library Registration” on page 68-42
• “Develop a Code Replacement Library” on page 68-13
• “What Is Code Replacement Customization?” on page 68-3
• “Code You Can Replace from MATLAB Code” on page 68-5
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Troubleshoot Code Replacement Library Registration
If a code replacement library is not listed as a configuration option or does not appear in the Code
Replacement Viewer:

• Refresh the library registration information within the current MATLAB session
(RTW.TargetRegistry.getInstance('reset'); or for the Simulink
environment,sl_refresh_customizations).

• See whether the registration file, rtwTargetInfo.m, contains an error.

See Also

More About
• “Register Code Replacement Library” on page 68-38
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Verify Code Replacement Library
Verify your code replacement library by examining its structure, replacement, and performance. Use
the Code Replacement Viewer (crviewer) to verify the structure of your library. Use the code
replacement report to verify the replacements made with your library in generated code. Use
crviewer again to verify the performance of your library during code generation by examining the
replacement hit and miss logs.

Verify Library Structure
Use the Code Replacement Viewer (crviewer) to open and view the structure of your code
replacement library by examining its tables and table entries.

1 From the MATLAB command prompt, open your code replacement library using the crviewer
with the command:

>> crviewer('library')
2 The viewer opens your code replacement library and shows its code replacement tables in the

left pane. Verify that your library lists all required tables in the correct relative order.
3 Open and view the entries for each code replacement table. In the crtool, click each table listed

in the left pane to view its entries in the middle pane.

If you are not using the crviewer, you can open each table directly from the MATLAB command
prompt with the command:

crviewer(table)
4 For each table in your library, verify that it lists all required entries in the correct relative order.

Verify that the conceptual representation and implementation representation are correct for each
entry in the table.

Verify Library Replacement
Use the Code Replacements Report to verify that when the code generator uses your code
replacement library it creates replacements as expected in the generated code. For each instance of
replacement, the Code Replacements Report provides a mapping between the Simulink block that
triggered the replacement and its implementation in the generated code. Use this mapping to verify
correct code replacement by tracing between the report and the code in either direction (from report
to code or code to report).

To generate the Code Replacements Report:

1 Configure your model to use your code replacement library.
2 Configure your model to open the Code Generation Report. The Code Replacements Report is a

tab within this report. In the Model Configuration Parameters dialog box, in the Code
Generation > Report pane, select:

• Create code generation report
• Open report automatically
• Model-to-code
• Summarize which block triggered code replacements
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3 Configure the generated code to include comments. In the Model Configuration Parameters
dialog box, in the Code Generation > Comments pane, select:

• Include comments
• Either or both of Simulink block comments and Simulink block descriptions

4 Build your model to generate code only. The Code Generation Report opens automatically. On the
left pane, click to open the Code Replacements Report.

5 Verify that code replacements occur as expected.

• Navigate from report to model: In the Code Replacements Report, click each block link to
see the source that triggered replacement.

• Navigate from model to report: In the Simulink model window, use model-to-code
highlighting to trace code replacements. Right-click blocks where you expected code
replacement to occur and select C/C++ Code > Navigate to C/C++ Code. The report
appears with the corresponding replacement code highlighted.

Verify Library Performance
Verify the performance of your code replacement library by examining the hits and misses that
occurred during code generation using your library. During code generation, when the code
generator finds a match for code replacement from your code replacement library, it logs the hit in a
hit cache. When it does not find a code replacement match, it logs the failed attempt in the miss
cache. Each time that you generate code, the code generator overwrites its previous hit and miss
cache logs.

To review trace information from the hit and miss cache data, use the Code Replacement Viewer
(crviewer). From the hit cache, you can identify when code replacement successfully occurred, and
from the miss cache, you can troubleshoot when code replacement did not take place. The miss cache
trace information provides you information about the reason for the miss, a link to the relevant
source location for the miss, and the call site object of the miss. For more information, see
“Troubleshoot Code Replacement Misses” on page 67-59.

Review Code Replacements
After you review the content of your code replacement library and tables, generate code and a code
generation report. Verify that the code generator replaces code as you expect.

The Code Replacements Report details the code replacement library functions that the code
generator uses for code replacements. The report provides a mapping between each replacement
instance and the line of MATLAB code that triggered the replacement. The Code Replacements report
is not available for generated MEX functions.

The following example illustrates two complementary approaches for reviewing code replacements:

• Check the Code Replacements Report section of the code generation report for expected
replacements.

• Trace code replacements.

1 Identify the MATLAB function where you anticipate that a function or operator replacement
occurs. This example uses the function matlabroot/toolbox/rtw/rtwdemos/crl_demo/
addsub_two_int16.m.
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function [y1, y2] = addsub_two_int16(u1, u2)

y1 = int16(u1 + u2);
y2 = int16(u1 - u2);

2 Identify or create code or a script to exercise the function. For example, consider test file
addsub_to_int16_test.m, which includes the following code:

disp('Input')
u1 = int16(10)
u2 = int16(10)

[y1, y2] = addsub_two_int16(u1, u2);

disp('Output')
disp('y1 =')
disp(y1);
disp('y2 =')
disp(y2);

3 Open the MATLAB Coder app.
4 On the Select Source Files page, add your function to the project. For this example, add

function addsub_two_int16. Click Next.
5 On the Define Input Types page, use the test file addsub_to_int16_test to automatically

define the input types. Click Next.
6 On the Check for Run-Time Issues page, specify the test file addsub_to_int16_test. The

app runs the test file, replacing calls to addsub_to_int16_test with calls to a MEX version of
addsub_to_int16_test. Click Next.

7 To open the Generate dialog box, on the Generate Code page, click the Generate arrow .
8 Set Build type to generate source code. Before you build an executable, you want to review your

code replacements in the generated code.
9 In the Generate dialog box, click More Settings.
10 Configure the code generator to use your code replacement library. On the Custom Code tab,

set the Code replacement library parameter to the name of your library. For this example, set
the library to Addition & Subtraction Examples.

11 Configure the code generation report to include the Code Replacements Report. On the
Debugging tab, select:

• Always create a code generation report
• Code replacements
• Automatically launch a report if one is generated

12 To generate code and a report, set Build type to Source Code. Then, click Generate.
13 Open the Code Replacements Report section of the code generation report.

That report lists the replacement functions that the code generator used. The report provides a
mapping between each replacement instance and the MATLAB code that triggered the
replacement.

Review the report:

• Check whether expected function and operator code replacements occurred.
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• In the replacements sections, click each code link to see the source that triggered the
reported code replacement.

If a function or operator is not replaced as expected, the code generator used a higher-priority
(lower-priority value) match or did not find a match.

To analyze and troubleshoot code replacement misses, use the trace information that the Code
Replacement Viewer provides.

See Also

More About
• “Troubleshoot Code Replacement Misses” on page 68-47
• “Register Code Replacement Library” on page 68-38
• “Deploy Code Replacement Library” on page 68-50
• “Develop a Code Replacement Library” on page 68-13
• “What Is Code Replacement Customization?” on page 68-3
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Troubleshoot Code Replacement Misses
Use miss reason messages that appear in the Code Replacement Viewer to analyze and correct
code replacement misses.

Miss Reason Messages
The Code Replacement Viewer displays miss reason messages in trace information for code
replacement misses. A legend listing each message that appears in the miss report precedes the
report details. A message consists of:

• Numeric identifier, which identifies the message in the report details.
• Message text, which in some cases includes placeholders for names of arguments, call site object

values, table entry values, and property names.

For example:

1. Mismatched data types (argument name, CSO value, table entry value)

The parenthetical information represents placeholders for actual values that appear in the report
details.

In the Miss Source Locations table that lists the miss details, the Reason column includes:

• The message identifier, as listed in the legend.
• The placeholder values for that instance of the miss reason message.

The following Reason details indicate a data type mismatch because the call site object specifies data
type int8 for arguments y1, u1, and u2, while the code replacement table entry specifies uint32.

1. y1, int8, uint32
   u1, int8, uint32
   u2, int8, uint32

Depending on your situation and the reported miss reason, troubleshoot reported misses by looking
for instances of the following:

• A typo in the code replacement table entry definition or a source parameter setting.
• Information missing from the code replacement table entry or a source parameter setting.
• Invalid or incorrect information in the code replacement table entry definition or a source

parameter setting.
• Arguments incorrectly ordered in the code replacement table entry definition or the source being

replaced with replacement code.
• Failed algorithm classification for an addition or subtraction operation due to:

• An ideal accumulator not being calculated because the type of an input argument is not fixed-
point or the slope adjustment factors of the input arguments are not equal.

• Input or output casts with a floating-point cast type.
• Input or output casts with cast types that have different slope adjustment factors or biases.
• Output casts not being convertible to a single output cast.
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• Input casts resulting in loss of bits.

Analyze and Correct Code Replacement Misses
The following example shows how to use Code Replacement Viewer trace information to troubleshoot
code replacement misses. You must have already reviewed and tested code replacements for your
MATLAB code.

1 Review the code generated for a specific code element, looking for expected code replacement.
Regenerate or reopen the code generation report for your MATLAB code. If you already
generated the code generation report that includes the Code Replacements Report for
matlabroot/toolbox/rtw/rtwdemos/crl_demo/addsub_two_int16.m, open the file
codegen/lib/addsub_two_int16/html/mldatx.html. For information on how to
regenerate the report, see “Verify Code Replacement Library” on page 68-43.

To examine the code generated for the function, from the code generation report, open the
generated file addsub_two_int16.h.

extern void addsub_two_int16(double u1, double u2, short *b_y1, short *y2);

The code generator replaced code, but the replacement is for the signed version of the 16-bit
addition and subtraction operations. You expected code replacements for operations on unsigned
data.

2 Open the Code Replacements Report for the MATLAB code.
3 Click the link to open the Code Replacement Viewer.
4 In the viewer left pane, select your code replacement table. For this example, select code

replacement table crl_table_addsub.
5 In the middle pane, select table entry RTW_OP_ADD with implementation function

u16_add_u16_u16.
6 In the right pane, select the Trace Information tab.

The Trace Information is a table that lists the following information for each miss:

• Call site object preview. The call site object is the conceptual representation of addition
operator. The code generator uses this object to query the code replacement library for a
match.

• A link to the source location in the MATLAB function where the code generator considered
replacing code.

• The reasons that the miss occurred. See “Miss Reason Messages” on page 68-47.

For this example, the report shows misses for function addsub_two_int16.m.
7 Find the source in the trace information. Depending on your situation and the reported miss

reason, consider looking for a condition such as a typo in the code replacement table entry
definition or a source parameter setting. For a list of conditions to consider, see“Miss Reason
Messages” on page 68-47.

For this example, determine why code for function addsub_two_int16 is not replaced with
code for an unsigned 16-bit addition operation. The miss reasons for the function indicate data
type and algorithm mismatches:

• The data type in the call site object is a signed 16-bit integer. The code replacement entry
specifies an unsigned 16-bit integer.

68 Code Replacement Customization for MATLAB Code

68-48



• The algorithm property in the call site object is RTW_CAST_AFTER_OP while the code
replacement entry specifies RTW_CAST_BEFORE_OP.

8 Fix the specified MATLAB code and relevant specifications or code replacement table entry. If the
issue concerns the MATLAB code, use the source location in the trace information to find the
code to fix. For this example, you expected an unsigned addition operation to occur for the
addsub_two_int16 function.

To fix the mismatches, in the test file addsub_to_int16_test, change the data types
definitions for u1 and u2 as follows:

u1 = uint16(10)
u2 = uint16(10)

In the MATLAB Coder app:

• Open the project that contains the addsub_to_int16 function.
• Use the updated test file addsub_to_int16_test to automatically redefine the input types.
• Change the addition and subtraction algorithm setting. Open the code replacement library

crl_table_addsub. Change the entry Algorithm parameter setting from Cast before
operation (RTW_CAST_BEFORE_OP) to Cast after operation (RTW_CAST_AFTER_OP).

• Regenerate code and a report.
9 From the Code Replacements Report, open the Code Replacement Viewer. Use the Code

Replacement Viewer trace information to verify that your MATLAB code or code replacement
table entry corrects the code replacement issue. The trace information shows a hit for function
addsub_two_int16.

See Also

More About
• “Verify Code Replacement Library” on page 68-43
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Deploy Code Replacement Library
Package and deploy your code replacement library.

1 Move your code replacement library customization and registration files to a location on the
MATLAB® search path that is accessible to other users. If another registration file already exists
in that location, copy and paste the information for your code replacement library into the
existing registration file.

2 Refresh your session and verify that the library is available as a configuration option for the code
generator.

3 Verify that code replacement occurs as expected in generated code.
4 Inform users that the code replacement library is available.

See Also

More About
• “Verify Code Replacement Library” on page 68-43
• “Package Code for Other Development Environments”
• “Develop a Code Replacement Library” on page 68-13
• “What Is Code Replacement Customization?” on page 68-3
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Math Function Code Replacement
This example shows how to develop a code replacement library to optimize the performance of math
functions by providing information on how to define code replacement for a sin function. To develop
a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_sin. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select sin. Algorithm information

appears in the crtool. For this example, leave the parameter unspecified.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1, with the Data Type of double and
the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

7 Specify build information. Click the Build Information tab to open the build requirements pane.
Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_sin
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_table_sin
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = rtw.TflCFunctionEntry;

 Math Function Code Replacement

68-53



4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_sin()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'sin', ...
        'Priority',                    30, ...
        'ImplementationName',          'mySin', ...
        'ImplementationHeaderFile',    'basicMath.h', ...
        'ImplementationSourceFile',    'basicMath.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_table_sin()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'sin', ...
        'Priority',                    30, ...
        'ImplementationName',          'mySin', ...
        'ImplementationHeaderFile',    'basicMath.h', ...
        'ImplementationSourceFile',    'basicMath.c');

%% Create the conceptual representation
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'y1',...
        'IOType',                 'RTW_IO_OUTPUT',...
        'DataTypeMode',           'double');

hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'u1', ...
        'IOType',                 'RTW_IO_INPUT',...
        'DataTypeMode',           'double');

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
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function hTable = crl_table_sin()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
        'Key',                         'sin', ...
        'Priority',                    30, ...
        'ImplementationName',          'mySin', ...
        'ImplementationHeaderFile',    'basicMath.h', ...
        'ImplementationSourceFile',    'basicMath.c');

%% Create the conceptual representation
hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'y1',...
        'IOType',                 'RTW_IO_OUTPUT',...
        'DataTypeMode',           'double');

hEntry.createAndAddConceptualArg(...
        'RTW.TflArgNumeric',      ...
        'Name',                   'u1', ...
        'IOType',                 'RTW_IO_INPUT',...
        'DataTypeMode',           'double');

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_sin

9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for sin function replacement’;
this(1).TableList = {'crl_table_sin.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';
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end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Memory Function Code Replacement” on page 68-57
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Memory Function Code Replacement
This example shows how to develop a code replacement library to optimize the performance of
memory functions by providing information on how to define code replacement for a memcpy
function. To develop a code replacement library use either the interactive or programmatic approach.
For more information, see “Develop a Code Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_memcpy. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select memcpy.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of void and the Argument Type of Pointer,
the input arguments, u1 and u2 with the Data Type of void and the Argument Type of Pointer
and u3 with the Data Type of unsigned integral and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations

68 Code Replacement Customization for MATLAB Code

68-58



10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_memcpy()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = rtw.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
% Set SideEffects to 'true' for function returning void to prevent it from 
% being optimized away.
hEntry.setTflCFunctionEntryParameters(...
                               'Key',                      'memcpy', ...
                               'Priority',                 90, ...
                               'ImplementationName',       'memcpy_int', ...
                               'ImplementationHeaderFile', 'memcpy_int.h',...
                               'SideEffects',              true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.
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function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
% Set SideEffects to 'true' for function returning void to prevent it from 
% being optimized away.
hEntry.setTflCFunctionEntryParameters(...
                               'Key',                      'memcpy', ...
                               'Priority',                 90, ...
                               'ImplementationName',       'memcpy_int', ...
                               'ImplementationHeaderFile', 'memcpy_int.h',...
                               'SideEffects',              true);

%% Create conceptual arguments
arg = getTflArgFromString(hTable, 'y1', 'void*');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u2', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u3', 'size_t');
addConceptualArg(hEntry, arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTable = crl_table_memcpy()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
                               'Key',                      'memcpy', ...
                               'Priority',                 90, ...
                               'ImplementationName',       'memcpy_int', ...
                               'ImplementationHeaderFile', 'memcpy_int.h',...
                               'SideEffects',              true);

%% Create conceptual arguments
arg = getTflArgFromString(hTable, 'y1', 'void*');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u2', 'void*');
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u3', 'size_t');
addConceptualArg(hEntry, arg);
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%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_memcpy
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for memory function replacement’;
this(1).TableList = {'crl_table_memcpy.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Math Function Code Replacement” on page 68-51
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Specify In-Place Code Replacement
In-place code replacement is an optimization technique that uses a single buffer, that is, the same
memory, to store function input and output data, as in x=foo(x).

You can develop a code replacement library to optimize in-place function argument replacement . To
develop a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_inplace. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as customFunction .
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1, with the Data Type of double and
the Argument Type of Pointer.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. Add the implementation parameter y1 and u1. For each
input argument that you want to specify as in-place with a corresponding output argument, in the
Argument properties box, select the Pointer check box. For the implementation parameter y1in
the Argument properties section of the dialog box, set the In-place argument to u1.

7 Specify build information. Click the Build Information tab to open the build requirements pane.
Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
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more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_inplace()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_table_inplace
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = rtw.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_inplace()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
       'Key', 'customFunction', ...
       'Priority', 100, ...
       'ImplementationName', 'custom_function_inplace_impl', ...
       'SideEffects', true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString and addConceptualArg.

function hTable = crl_table_inplace()
% Create a code replacement library table 
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%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
       'Key', 'customFunction', ...
       'Priority', 100, ...
       'ImplementationName', 'custom_function_inplace_impl', ...
       'SideEffects', true);

%% Create the conceptual representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hEntry, 'u1','double');
addConceptualArg(hEntry, arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. This example uses calls to the getTflArgFromString
function to create implementation arguments that map to arguments in the replacement function
prototype: output argument y1 and input argument u1. For each argument, the example uses the
convenience method setReturn or addArgument to specify whether an argument is a return
value or argument. For each argument, this example adds the argument to the entry array of
implementation arguments.

function hTable = crl_table_inplace()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters(...
       'Key', 'customFunction', ...
       'Priority', 100, ...
       'ImplementationName', 'custom_function_inplace_impl', ...
       'SideEffects', true);

%% Create the conceptual representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hEntry, 'u1','double');
addConceptualArg(hEntry, arg);

%% Create the Implementation Representation

arg = getTflArgFromString(hEntry, 'y2','void');
arg.IOType = 'RTW_IO_OUTPUT';
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hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hEntry, 'u1','double*');
arg.ArgumentForInPlaceUse = 'y1';
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table

hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_inplace

9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for inplace function replacement’;
this(1).TableList = {'crl_table_inplace.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations

10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Math Function Code Replacement” on page 68-51
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Data Alignment for Code Replacement
Code replacement libraries can align data objects passed into a replacement function to a specified
boundary.

Code Replacement Data Alignment
You can take advantage of function implementations that require aligned data to optimize application
performance when using MATLAB Coder. To configure data alignment for a function implementation:

1 Specify the data alignment requirements in a code replacement entry. Specify alignment
separately for each implementation function argument or collectively for all function arguments.
See “Specify Data Alignment Requirements for Function Arguments” on page 67-97.

2 Specify the data alignment capabilities and syntax for one or more compilers. Include the
alignment specifications in a library registration entry in the rtwTargetInfo.m file. See
“Provide Data Alignment Specifications for Compilers” on page 67-98.

3 Register the library containing the table entry and alignment specification object.
4 Configure the code generator to use the code replacement library and generate code. Observe

the results.

For examples, see “Basic Example of Code Replacement Data Alignment” on page 67-101 and the
“Data Alignment for Function Implementations” section of the “Optimize Generated Code By
Developing and Using Code Replacement Libraries - Simulink®” on page 72-27 example page.

Note If replacement that requires alignment uses imported data (for example, I/O of an entry-point
function or exported function), specify the data alignment with coder.dataAlignment statements
in the MATLAB code. Specify alignment separately for each instance of imported data. See “Specify
Data Alignment in MATLAB Code for Imported Data” on page 68-72.

Specify Data Alignment Requirements for Function Arguments
To specify the data alignment requirement for an argument in a code replacement entry:

• If you are defining a replacement function in a code replacement table registration file, create an
argument descriptor object (RTW.ArgumentDescriptor). Use its AlignmentBoundary property
to specify the required alignment boundary and assign the object to the argument Descriptor
property.

• If you are defining a replacement function using the Code Replacement Tool, on the Mapping
Information tab, in the Argument properties section for the replacement function, enter a
value for the Alignment value parameter.
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The AlignmentBoundary property (or Alignment value parameter) specifies the alignment
boundary for data passed to a function argument, in number of bytes. The AlignmentBoundary
property is valid only for addressable objects, including matrix and pointer arguments. It is not
applicable for value arguments. Valid values are:

• -1 (default) — If the data is a Simulink.Bus, Simulink.Signal, or Simulink.Parameter
object, specifies that the code generator determines an optimal alignment based on usage.
Otherwise, specifies that there is not an alignment requirement for this argument.

• Positive integer that is a power of 2, not exceeding 128 — Specifies number of bytes in the
boundary. The starting memory address for the data allocated for the function argument is a
multiple of the specified value. If you specify an alignment boundary that is less than the natural
alignment of the argument data type, the alignment directive is emitted in the generated code.
However, the target compiler ignores the directive.

The following code specifies the AlignmentBoundary for an argument as 16 bytes.

hLib = RTW.TflTable;
entry = RTW.TflCOperationEntry;
arg = getTflArgFromString(hLib, 'u1','single*');
desc = RTW.ArgumentDescriptor;
desc.AlignmentBoundary = 16;
arg.Descriptor = desc;
entry.Implementation.addArgument(arg);

The equivalent alignment boundary specification in the Code Replacement Tool dialog box is in this
figure.

Note If your model imports Simulink.Bus, Simulink.Parameter, or Simulink.Signal objects,
specify an alignment boundary in the object properties, using the Alignment property. For more
information, see Simulink.Bus, Simulink.Parameter, and Simulink.Signal.
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Provide Data Alignment Specifications for Compilers
To support data alignment in generated code, describe the data alignment capabilities and syntax for
your compilers in the code replacement library registration. Provide one or more alignment
specifications for each compiler in a library registry entry.

To describe the data alignment capabilities and syntax for a compiler:

• If you are defining a code replacement library registration entry in a rtwTargetInfo.m
customization file, add one or more AlignmentSpecification objects to an
RTW.DataAlignment object. Attach the RTW.DataAlignment object to the
TargetCharacteristics object of the registry entry.

The RTW.DataAlignment object also has the property DefaultMallocAlignment, which
specifies the default alignment boundary, in bytes, that the compiler uses for dynamically allocated
memory. If the code generator uses dynamic memory allocation for a data object involved in a
code replacement, this value determines if the memory satisfies the alignment requirement of the
replacement. If not, the code generator does not use the replacement. The default value for
DefaultMallocAlignment is -1, indicating that the default alignment boundary used for
dynamically allocated memory is unknown. In this case, the code generator uses the natural
alignment of the data type to determine whether to allow a replacement.

Additionally, you can specify the alignment boundary for complex types by using the
addComplexTypeAlignment function.

• If you are generating a customization file function using the Code Replacement Tool, fill out the
following fields for each compiler.

Click the plus (+) symbol to add additional compiler specifications.

For each data alignment specification, provide the following information.
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Alignment‐
Specification
Property

Dialog Box
Parameter

Description

AlignmentType Alignment type Cell array of predefined enumerated strings, specifying which
types of alignment this specification supports.

• DATA_ALIGNMENT_LOCAL_VAR — Local variables.
• DATA_ALIGNMENT_GLOBAL_VAR — Global variables.
• DATA_ALIGNMENT_STRUCT_FIELD — Individual structure
fields.

• DATA_ALIGNMENT_WHOLE_STRUCT — Whole structure, with
padding (individual structure field alignment, if specified, is
favored and takes precedence over whole structure
alignment).

Each alignment specification must specify at least
DATA_ALIGNMENT_GLOBAL_VAR and
DATA_ALIGNMENT_STRUCT_FIELD.

AlignmentPosition Alignment
position

Predefined enumerated string specifying the position in which you
must place the compiler alignment directive for alignment type
DATA_ALIGNMENT_WHOLE_STRUCT:

• DATA_ALIGNMENT_PREDIRECTIVE — The alignment directive
is emitted before struct st_tag{…}, as part of the type
definition statement (for example, MSVC).

• DATA_ALIGNMENT_POSTDIRECTIVE — The alignment
directive is emitted after struct st_tag{…}, as part of the
type definition statement (for example, gcc).

• DATA_ALIGNMENT_PRECEDING_STATEMENT — The alignment
directive is emitted as a standalone statement immediately
preceding the definition of the structure type. A semicolon (;)
must terminate the registered alignment syntax.

• DATA_ALIGNMENT_FOLLOWING_STATEMENT — The alignment
directive is emitted as a standalone statement immediately
following the definition of the structure type. A semicolon (;)
must terminate the registered alignment syntax.

For alignment types other than
DATA_ALIGNMENT_WHOLE_STRUCT, code generation uses
alignment position DATA_ALIGNMENT_PREDIRECTIVE.
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Alignment‐
Specification
Property

Dialog Box
Parameter

Description

AlignmentSyntax‐
Template

Alignment
syntax

Specifies the alignment directive string that the compiler
supports. The string is registered as a syntax template that has
placeholders in it. These placeholders are supported:

• %n — Replaced by the alignment boundary for the replacement
function argument.

• %s — Replaced by the aligned symbol, usually the identifier of
a variable.

For example, for the gcc compiler, you can specify
__attribute__((aligned(%n))), or for the MSVC compiler,
__declspec(align(%n)).

SupportedLanguages Supported
languages

Cell array specifying the languages to which this alignment
specification applies, among c and c++. Sometimes alignment
syntax and position differ between languages for a compiler.

Here is a data alignment specification for the GCC compiler:
da = RTW.DataAlignment;

as = RTW.AlignmentSpecification;
as.AlignmentType = {'DATA_ALIGNMENT_LOCAL_VAR', ...
                    'DATA_ALIGNMENT_STRUCT_FIELD', ...
                    'DATA_ALIGNMENT_GLOBAL_VAR'};
as.AlignmentSyntaxTemplate = '__attribute__((aligned(%n)))';
as.AlignmentPosition = 'DATA_ALIGNMENT_PREDIRECTIVE';
as.SupportedLanguages = {'c', 'c++'};
da.addAlignmentSpecification(as);

tc = RTW.TargetCharacteristics;
tc.DataAlignment = da;

Here is the corresponding specification in the Generate customization dialog box of the Code
Replacement Tool.
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Specify Data Alignment in MATLAB Code for Imported Data
If MATLAB Coder code replacements that require data alignment use imported data, such as an
entry-point or exported function I/O, specify data alignment to external code with
coder.dataAlignment statements in the MATLAB code.

If MATLAB Coder code replacements occur that require data alignment (uses imported data), such as
an entry-point or exported function with I/O, specify code replacement data alignment with
coder.DataAlignment statements in the MATLAB code.

To specify the data alignment requirements for imported data in a MATLAB code:

• For each instance of imported data that requires data alignment, specify the alignment in the
function with a coder.dataAlignment statement of the form:

coder.dataAlignment('varName', align_value)
• The varName is a character array of the variable name that requires alignment information
specification. The align_value is an integer number which should be a power of 2, from 2
through 128. This number specifies the power-of-2 byte alignment boundary.

• An example function that specifies data alignment is:

function y = testFunction(x1,x2)

coder.dataAlignment('x1',16);      % Specifies information
coder.dataAlignment('x2',16);    % Specifies information
coder.dataAlignment('y',16);     % Specifies information

y = x1 + x2;

end

If testFunction is an entry-point or exported function, imported data x1, x2, and y are not aligned
automatically by the code generator. The coder.DataAlignment statements for these variables are
only meant as information for the code generator. The call sites allocating memory for the data need
to ensure that the data is aligned as specified.

You also can specify code replacement data alignment for exported data, such as a global variable
or an ExportedGlobal storage class. For more information, see “Choose Storage Class for
Controlling Data Representation in Generated Code” on page 34-74.

See Also

More About
• “Code You Can Replace From Simulink Models” on page 67-6
• “Define Code Replacement Library Optimizations” on page 67-36
• “Develop a Code Replacement Library” on page 67-20
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Array Layout and Code Replacement
To improve execution speed of algorithms or simplify integration with external code or data, you can
define code replacement mappings that apply a specific layout for storing array elements in memory.
By default, the code generator stores array elements in a column-major layout. To change the layout
to row-major, change the value of the entry parameter ArrayLayout to ROW_MAJOR.

The following table definition file for a sum operation uses the row-major array layout.

1 Create a table definition file that contains a function definition. For example:

function hTable = crl_table_rowmajor_matrix
2 Within the function body, create the table by calling the function RTW.TflTable.

hTable = RTW.TflTable;
3 Create an entry for the operator mapping with a call to the RTW.TflCOperationEntry

function.

% Create operation entry
hEnt = RTW.TflCOperationEntry;

4 Set operator entry parameters with a call to the setTflCOperationEntryParameters
function. In the function call, set the parameter ArrayLayout to ROW_MAJOR

setTflCOperationEntryParameters(hEnt, ...
                    'Key',                      'RTW_OP_ADD', ...
                    'Priority',                 100, ...
                    'ArrayLayout',              'ROW_MAJOR', ...   
                    'ImplementationName',        'MyMul_ROW', ...
                    'ImplementationHeaderFile', 'MyMul_ROW.h', ...
                    'ImplementationSourceFile', 'MyMul_ROW.c');

5 Create conceptual arguments y1, u1, and u2. There are multiple ways to set up the conceptual
arguments. This example uses calls to the getTflArgFromString and addConceptualArg
functions to create and add the arguments.

arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'double'); 
arg.DimRange = [2 2; 50 50]; 
hEnt.addConceptualArg(arg); 

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'double'); 
arg.DimRange = [2 3; 2 3]; 
hEnt.addConceptualArg(arg); 

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'double'); 
arg.DimRange = [3 4; 3 4]; 
hEnt.addConceptualArg(arg); 

6 Create the implementation arguments. There are multiple ways to set up the implementation
arguments. This example uses calls to the getTflArgFromString function to create the
arguments. When defining the implementation function return argument, create a void output
argument. When defining the implementation function argument for the conceptual output
argument (y1), set the operator output argument as an additional input argument. Mark its
IOType as output. Make its type a pointer type. The convenience methods setReturn and
addArgument specify whether an argument is a return value or argument and adds the
argument to the entry’s array of implementation arguments.
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% Implementation Args  
arg = hEnt.getTflArgFromString('unused','void'); 
arg.IOType = 'RTW_IO_OUTPUT'; 
hEnt.Implementation.setReturn(arg);  

arg = hEnt.getTflArgFromString('u1','double*'); 
hEnt.Implementation.addArgument(arg); 

arg = hEnt.getTflArgFromString('u2','double*'); 
hEnt.Implementation.addArgument(arg); 

arg = hEnt.getTflArgFromString('y1','double*'); 
arg.IOType = 'RTW_IO_OUTPUT'; 
hEnt.Implementation.addArgument(arg); 

arg = hEnt.getTflArgFromString('u3','uint32',2); 
arg.Type.ReadOnly = true; 
hEnt.Implementation.addArgument(arg); 

arg = hEnt.getTflArgFromString('u4','uint32',3); 
hEnt.Implementation.addArgument(arg); 

arg = hEnt.getTflArgFromString('u5','uint32',3); 
hEnt.Implementation.addArgument(arg); 

arg = hEnt.getTflArgFromString('u6','uint32',4); 
hEnt.Implementation.addArgument(arg); 

7 Add the entry to a code replacement table with a call to the addEntry function.

addEntry(hTable, hEnt);
8 Save the table definition file. To name the file, use the name of the table definition function .

Then, generate code and a code generation report and review the code replacements.

See Also
coder.replace | setTflCFunctionEntryParameters | setTflCOperationEntryParameters

More About
• “Row-Major and Column-Major Array Layouts”
• “Define Code Replacement Library Optimizations” on page 67-36
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Allow Shape Agnostic Match
Code replacement shape-agnostic match allows matrix inputs for certain operations to be matched
based on the number of elements as opposed to matrix shape. For example, a 6x1 matrix matches a
2x3 matrix in shape-agnostic match because both have a total of 6 elements. Such matches can only
be made if the output and inputs are contiguously allocated in memory and if the replacement
function can be performed element-wise. Shape-agnostic matrix match increases replacement rate so
it is advantageous for replacement that does not require matrix shape to be considered.

Shape-agnostic code replacement entries can be created either with the user interface of the Code
Replacement Tool or programmatically.

User Interface Method- Code Replacement Tool
This example shows how to set up shape-agnostic matrix replacement for an addition code
replacement table entry.

1 Open the Code Replacement Tool. From the MATLAB command line, enter crtool.
2 Create a code replacement table. Go to File > New Table.
3 Create a table entry. Shape-agnostic matrix replacement only supports Math Operation table

entries. Either right-click on your table or go to File > New Entry and select Math
Operation. Mapping information appears. From the Operation drop down menu, select
addition.

4 Create conceptual arguments. The Conceptual operation section defines each of your
conceptual arguments. To enable shape-agnostic replacement set the Argument type: to
matrix to open the Matrix entry properties menu.

5 Set entry parameters. In the Matrix entry properties menu, select the Allow shape-
agnostic match checkbox to enable shape-agnostic replacement.

6 Validate your table entry. Either click the validate entry button or right-click the entry and
select Validate entries.

7 Click save.

This display shows the Code Replacement Tool settings for this example.
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Programmatic Method
This example shows how to set up a shape-agnostic matrix replacement for an addition code
replacement table entry.

1 Create the code replacement table. Create a function definition with the table name
'ShapeAgnosticTable'. Call RTW.TflTable to create the table.

function hLib = ShapeAgnosticTable
hLib = RTW.TflTable;

2 Create a table entry for code replacement. Shape-agnostic replacement only supports operation
entries, as specified with a call to RTW.TflCOperationEntry.

hEnt = RTW.TflCOperationEntry;
3 Set entry parameters to customize input processing. You can enable shape-agostic matrix

replacement by setting the entry parameter 'AllowShapeAgnosticMatch' to true.

hEnt.setTflCOperationEntryParameters( ...
          'Key', 'RTW_OP_ADD', ...
          'Priority', 100, ...
          'AllowShapeAgnosticMatch', true, ...
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          'ImplementationName', 'MyAdd_Matrix', ...
          'SideEffects', true);

4 Create conceptual arguments. For this example, create conceptual arguments y1, u1, and u2 with
calls to the create function, RTW.TflArgMatrix, and add function, addConceptualArg.

arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'double');
arg.DimRange = [2 2; 50 50];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'double');
arg.DimRange = [2 3; 2 3];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'double');
arg.DimRange = [2 3; 2 3];
hEnt.addConceptualArg(arg);

5 Create implementation arguments. For this example, call the function getTflArgFromString
to create the arguments. Define the implementation return argument as a void output
argument. Define the conceptual output argument, y1, as a pointer with the IOType as output.

arg = hEnt.getTflArgFromString('unused','void');
arg.IOType = 'RTW_IO_OUTPUT';
hEnt.Implementation.setReturn(arg); 

arg = hEnt.getTflArgFromString('u1','double*');
hEnt.Implementation.addArgument(arg);

arg = hEnt.getTflArgFromString('u2','double*');
hEnt.Implementation.addArgument(arg);

arg = hEnt.getTflArgFromString('y1','double*');
arg.IOType = 'RTW_IO_OUTPUT';
hEnt.Implementation.addArgument(arg);

arg = hEnt.getTflArgFromString('numElements','uint32',6);
hEnt.Implementation.addArgument(arg);

6 Add this entry to a code replacement table with the function addEntry.

hLib.addEntry( hEnt ); 
7 Save the table as its function name. For this example, ShapeAgnosticTable.
8 Validate your entry at the MATLAB command line. Invoke the table definition file with the

following command.

hTbl = ShapeAgnosticTable

Example Model

An example of this code replacement table entry is demonstrated through the following model. Even
though the matrix shape in this model does not match the entry, the operation can be performed
element-wise and the entry enables shape-agnostic match, so code replacement is observed in the
generated code.
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 /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Sum: '<Root>/Add'
   */
  MyAdd_Matrix(Demo_U.In1, Demo_U.In2, Demo_Y.Out1, 6U);

Limitations
• If you enable shape-agnostic match for an operation that is inherently not computed element-wise,

a regular match is performed.
• When shape-agnostic match is enabled, code replacement does not honor the setting for

'DimRange'. Instead, it computes the number of elements and uses that value to match.
• If you are working with customized code replacement entries, adjust the 'do_match' function to

accept the total number of elements as opposed to matrix dimensions. For more information, see
“Customize Match and Replacement Process” on page 67-118.

See Also
setTflCOperationEntryParameters

More About
• “What Is Code Replacement Customization?” on page 67-3
• “Define Code Replacement Library Optimizations” on page 68-23
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Replace MATLAB Functions with Custom Code by Using the
coder.replace Function

You can develop a code replacement library to optimize the performance of MATLAB functions
containing a coder.replace function. To develop a code replacement library, use either the
interactive or programmatic approach. For more information, see “Develop a Code Replacement
Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_matlab_fcn_coder_replace. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as calculate.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1, with the Data Type of double and
the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Add the return argument y1 and the arguments u1.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
  'Key', 'calculate', ...
  'Priority', 100, ...
  'ArrayLayout', 'COLUMN_MAJOR', ...
  'ImplementationName', ...
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  'replacement_calculate_impl', ...
  'ImplementationHeaderFile', ...
  'replacement_calculate_impl.h', ...
  'ImplementationSourceFile', ...
  'replacement_calculate_impl.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
  'Key', 'calculate', ...
  'Priority', 100, ...
  'ArrayLayout', 'COLUMN_MAJOR', ...
  'ImplementationName', ...
  'replacement_calculate_impl', ...
  'ImplementationHeaderFile', ...
  'replacement_calculate_impl.h', ...
  'ImplementationSourceFile', ...
  'replacement_calculate_impl.c');

%% Create the conceptual representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hEntry, 'u1','double');
addConceptualArg(hEntry, arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.

function hTable = crl_matlab_fcn_coder_replace
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
setTflCFunctionEntryParameters(hEntry, ...
  'Key', 'calculate', ...
  'Priority', 100, ...
  'ArrayLayout', 'COLUMN_MAJOR', ...
  'ImplementationName', ...
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  'replacement_calculate_impl', ...
  'ImplementationHeaderFile', ...
  'replacement_calculate_impl.h', ...
  'ImplementationSourceFile', ...
  'replacement_calculate_impl.c');

%% Create the conceptual representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hEntry, 'u1','double');
addConceptualArg(hEntry, arg);

%% Create the Conceptual Representation
arg = getTflArgFromString(hEntry, 'y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = getTflArgFromString(hEntry, 'u1','double');
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_matlab_fcn_coder_replace
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for matlab function with custom code using coder.replace’;
this(1).TableList = {'crl_matlab_fcn_coder_replace.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.
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See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Replace coder.ceval Calls to External Functions” on page 68-85
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Replace coder.ceval Calls to External Functions
The coder.ceval function calls external C/C++ functions from code generated from MATLAB code.
The code replacement software supports replacement of the function that you specify in a call to
coder.ceval. An application of this code replacement scenario is to write generic MATLAB code
that you can customize for different platforms with code replacements. A code replacement library
can define hardware-specific code replacements for the function call. Use coder.ceval in MATLAB
code from which you want to generate C code using:

• MATLAB Coder
• MATLAB code in a Simulink MATLAB Function block

To develop a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 68-13.

Example Files
For the examples in “Interactively Develop a Code Replacement Library” on page 68-86 and
“Programmatically Develop a Code Replacement Library” on page 67-113 you must have set up the
following:

• Custom C function my_add.c.

/* my_add.c */

#include "my_add.h"

double my_add(double in1, double in2)
{
  return in1 + in2;
}

• Custom C header file my_add.h.

/* my_add.h */

double my_add(double in1, double in2);
• MATLAB function call_my_add.m, which uses coder.ceval to invoke my_add.c.

function y = call_my_add(in1, in2)  %#codegen

y=0.0;

if ~coder.target('Rtw')
% Executing in MATLAB, call MATLAB equivalent of C function my_add
  y= in1+in2;
else
% Executing in generated code, call C function my_add
  y = coder.ceval('my_add', in1, in2);
end

• MATLAB test function call_my_add_test.m, which calls call_my_add.m.

in1=10;
in2=20;
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y = call_my_add(in1, in2);

disp('Output')
disp('y =')
disp(y);

• Replacement C function my_add_replacement.c.

/* my_add_replacement.c */

#include "my_add_replacement.h"

double my_add_replacement(double in1, double in2)
{
  return in1 + in2;
}

• Replacement C header file my_add_replacement.h.

/* my_add_replacement.h */

double my_add_replacement(double in1, double in2);

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool

2 Create a table.

a From the crtool menu, select File > New Table.
b In the right pane, name the table crl_table_coder_cevals_calls. Click Apply.

3 Create an entry. From the crtool menu, select File > New entry > Function.
4 Create entry parameters. In the Function drop-down list, select custom. Function information

appears in the crtool. For this example, specify the parameter as my_add .
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input arguments, u1 and u2 with the Data Type of
double and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, set the Implementation header file to my_add_replacement.h.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

 Replace coder.ceval Calls to External Functions

68-87



To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable =  crl_table_coder_cevals_calls()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCFunctionEntry.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters( ...
          'Key', 'my_add', ...
          'Priority', 100, ...
          'ImplementationName', 'my_add_replacement', ...
          'ImplementationHeaderFile', 'my_add_replacement.h', ...
          'ImplementationSourceFile', 'my_add_replacement.c');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters( ...
          'Key', 'my_add', ...
          'Priority', 100, ...
          'ImplementationName', 'my_add_replacement', ...
          'ImplementationHeaderFile', 'my_add_replacement.h', ...
          'ImplementationSourceFile', 'my_add_replacement.c');

%% Create the conceptual representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);

arg = hEntry.getTflArgFromString('u1','double');
hEntry.addConceptualArg(arg);

arg = hEntry.getTflArgFromString('u2','double');
hEntry.addConceptualArg(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.

function hTable =  crl_table_coder_cevals_calls()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCFunctionEntry;

%% Create entry parameters
hEntry.setTflCFunctionEntryParameters( ...
          'Key', 'my_add', ...
          'Priority', 100, ...
          'ImplementationName', 'my_add_replacement', ...
          'ImplementationHeaderFile', 'my_add_replacement.h', ...
          'ImplementationSourceFile', 'my_add_replacement.c');

%% Create the conceptual representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.addConceptualArg(arg);
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arg = hEntry.getTflArgFromString('u1','double');
hEntry.addConceptualArg(arg);

arg = hEntry.getTflArgFromString('u2','double');
hEntry.addConceptualArg(arg);

%% Create the implementation representation
arg = hEntry.getTflArgFromString('y1','double');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = hEntry.getTflArgFromString('u1','double');
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u2','double');
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
hTable.addEntry(hEntry); 

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable =  crl_table_coder_cevals_calls
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for coder.ceval calls to external functions code replacement’;
this(1).TableList = {' crl_table_coder_cevals_calls.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.
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See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Replace MATLAB Functions with Custom Code by Using the coder.replace Function” on page

68-79
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Reserved Identifiers and Code Replacement
The code generator and C programming language use, internally, reserved keywords for code
generation. Do not use reserved keywords as identifiers or function names. Reserved keywords for
code generation include many code replacement library identifiers, the majority of which are function
names, such as acos.

To view a list of reserved identifiers for the code replacement library that you use to generate code,
specify the name of the library in a call to the function
RTW.TargetRegistry.getInstance.getTflReservedIdentifiers. For example:
crl_ids = RTW.TargetRegistry.getInstance.getTflReservedIdentifiers('GNU99 (GNU)')

In a code replacement table, the code generator registers each function implementation name
defined by a table entry as a reserved identifier. You can register additional reserved identifiers for
the table on a per-header-file basis. Providing additional reserved identifiers can help prevent
duplicate symbols and other identifier-related compile and link issues.

To register additional code replacement reserved identifiers, use the setReservedIdentifiers
function. This function registers specified reserved identifiers to be associated with a code
replacement table.

You can register up to four reserved identifier structures in a code replacement table. You can
associate one set of reserved identifiers with a code replacement library, while the other three (if
present) must be associated with ANSI C. The following example shows a reserved identifier
structure that specifies two identifiers and the associated header file.
d{1}.LibraryName = 'ANSI_C';
d{1}.HeaderInfos{1}.HeaderName = 'math.h';
d{1}.HeaderInfos{1}.ReservedIds = {'y0', 'y1'};

The code generator adds the identifiers to the list of reserved identifiers and honors them during the
build procedure.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Customize Match and Replacement Process” on page 68-93
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
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Customize Match and Replacement Process
During the build process, the code generator uses:

• Preset match criteria to identify functions and operators for which application-specific
implementations replace default implementations.

• Preset replacement function signatures.

It is possible that preset match criteria and preset replacement function signatures do not completely
meet your function and operator replacement needs. For example:

• You want to replace an operator with a particular fixed-point implementation function only when
fraction lengths are within a particular range.

• When a match occurs, you want to modify your replacement function signature based on compile-
time information, such as passing fraction-length values into the function.

To add extra logic into the code replacement match and replacement process, create custom code
replacement table entries. With custom entries, you can specify additional match criteria and modify
the replacement function signature to meet application needs.

To create a custom code replacement entry:

1 Create a custom code replacement entry class, derived from RTW.TflCFunctionEntryML (for
function replacement) or RTW.TflCOperationEntryML (for operator replacement).

2 In your derived class, implement a do_match method with a fixed preset signature as a MATLAB
function. In your do_match method, provide either or both of the following customizations that
instantiate the class:

• Add match criteria that the base class does not provide. The base class provides a match
based on:

• Argument number
• Argument name
• Signedness
• Word size
• Slope (if not specified with wildcards)
• Bias (if not specified with wildcards)
• Math modes, such as saturation and rounding
• Operator or function key

• Modify the implementation signature by adding additional arguments or setting constant
input argument values. You can inject a constant value, such as an input scaling value, as an
additional argument to the replacement function.

3 Create code replacement entries that instantiate the custom entry class.
4 Register a library containing the code replacement table that includes your entries.

During code generation, the code replacement match process tries to match function or operator call
sites with the base class of your derived entry class. If the process finds a match, the software calls
your do_match method to execute your additional match logic (if any) and your replacement function
customizations (if any).
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Customize Match and Replacement Process for Operators
This example shows how to create custom code replacement entries that add logic to the code match
and replacement process for a scalar operation. Custom entries specify additional match criteria or
modify the replacement function signature to meet application needs.

For example:

• When fraction lengths are within a specific range, replace an operator with a fixed-point
implementation function.

• When a match occurs, modify the replacement function signature based on compile-time
information, such as passing fraction-length values into the function.

This example modifies a fixed-point addition replacement such that the implementation function
passes in the fraction lengths of the input and output data types as arguments.

To create custom code replacement entries that add logic to the code replacement match and
replacement process:

1 Create a class, for example TflCustomOperationEntry, that is derived from the base class
RTW.TflCOperationEntryML. The derived class defines a do_match method with the following
signature:

function ent = do_match(hThis, ...
        hCSO, ...
        targetBitPerChar, ...
        targetBitPerShort, ...
        targetBitPerInt, ...
        targetBitPerLong, ...
        targetBitPerLongLong) 

In the do_match signature:

• ent is the return handle, which is returned as empty (indicating that the match failed) or as a
TflCOperationEntry handle.

• hThis is the handle to the class instance.
• hCSO is a handle to an object that the code generator creates for querying the library for a

replacement.
• Remaining arguments are the number of bits for various data types of the current target.

The do_match method adds match criteria that the base class does not provide. The method
makes modifications to the implementation signature. In this case, the do_match method relies
on the base class for checking word size and signedness. do_match must match only the number
of conceptual arguments to the value 3 (two inputs and one output) and the bias for each
argument to value 0. If the code generator finds a match, do_match:

• Sets the return handle.
• Removes slope and bias wild cards from the conceptual arguments (the match is for specific

slope and bias values).
• Writes fraction-length values for the inputs and output into replacement function arguments

3, 4, and 5.

You can create and add three additional implementation function arguments for passing fraction
lengths in the class definition or in each code replacement entry definition that instantiates this
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class. This example creates the arguments, adds them to a code replacement table definition file,
and sets them to specific values in the class definition code.
classdef TflCustomOperationEntry < RTW.TflCOperationEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok

      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This class will check additional data and can
      % modify the implementation function.

      % The base class checks word size and signedness. Slopes and biases
      % have been wildcarded, so the only additional checking to do is
      % to check that the biases are zero and that there are only three
      % conceptual arguments (one output, two inputs)

      ent = []; % default the return to empty, indicating the match failed

      if length(hCSO.ConceptualArgs) == 3 && ...
          hCSO.ConceptualArgs(1).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(2).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(3).Type.Bias == 0

        % Modify the default implementation. Since this is a
        % generator entry, a concrete entry is created using this entry
        % as a template. The type of entry being created is a standard
        % TflCOperationEntry. Using the standard operation entry
        % provides required information, and you do not need
        % a custom match function.
        ent = RTW.TflCOperationEntry(hThis);

        % Since this entry is modifying the implementation for specific
        % fraction-length values (arguments 3, 4, and 5), the conceptual argument
        % wild cards must be removed (the wildcards were inherited from the
        % generator when it was used as a template for the concrete entry).
        % This concrete entry is now for a specific slope and bias. 
        % hCSO holds the slope and bias values (created by the code generator).
        for idx=1:3
          ent.ConceptualArgs(idx).CheckSlope = true;
          ent.ConceptualArgs(idx).CheckBias = true;

          % Set the specific Slope and Biases
          ent.ConceptualArgs(idx).Type.Slope = hCSO.ConceptualArgs(idx).Type.Slope;
          ent.ConceptualArgs(idx).Type.Bias = 0;
        end

        % Set the fraction-length values in the implementation function.
        ent.Implementation.Arguments(3).Value = ...
           -1.0*hCSO.ConceptualArgs(2).Type.FixedExponent;
        ent.Implementation.Arguments(4).Value = ...
           -1.0*hCSO.ConceptualArgs(3).Type.FixedExponent;
        ent.Implementation.Arguments(5).Value = ...
           -1.0*hCSO.ConceptualArgs(1).Type.FixedExponent;
      end
    end
  end
end

Exit the class folder and return to the previous working folder.
2 Create and save the following code replacement table definition file,

crl_table_custom_add_ufix32.m. This file defines a code replacement table that contains a
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single operator entry, an entry generator for unsigned 32-bit fixed-point addition operations, with
arbitrary fraction-length values on the inputs and the output. The table entry:

• Instantiates the derived class TflCustomOperationEntry from the previous step. If you
want to replace word sizes and signedness attributes, you can use the same derived class, but
not the same entry, because you cannot use a wild card with the WordLength and IsSigned
arguments. For example, to support uint8, int8, uint16, int16, and int32, add five other
distinct entries. To use different implementation functions for saturation and rounding modes
other than overflow and round to floor, add entries for those match permutations.

• Sets operator entry parameters with the call to
the setTflCOperationEntryParameters function.

• Calls the createAndAddConceptualArg function to create conceptual arguments y1, u1,
and u2.

• Calls createAndSetCImplementationReturn and createAndAddImplementationArg
to define the signature for the replacement function. Three of the calls to
createAndAddImplementationArg create implementation arguments to hold the fraction-
length values for the inputs and output. Alternatively, the entry can omit those argument
definitions. Instead, the do_match method of the derived class TflCustomOperationEntry
can create and add the three implementation arguments. When the number of additional
implementation arguments required can vary based on compile-time information, use the
alternative approach.

• Calls addEntry to add the entry to a code replacement table.

function hTable = crl_table_custom_add_ufix32

hTable = RTW.TflTable;

% Add TflCustomOperationEntry
op_entry = TflCustomOperationEntry;

setTflCOperationEntryParameters(op_entry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

createAndAddConceptualArg(op_entry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'BinaryPoint', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(op_entry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
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      'Scaling',    'BinaryPoint', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(op_entry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'BinaryPoint', ...
       'IsSigned',   false, ...
       'WordLength', 32);

% Specify replacement function signature
createAndSetCImplementationReturn(op_entry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 3 fraction-length args. Actual values are set during code generation.
createAndAddImplementationArg(op_entry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(op_entry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_out', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
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    'FractionLength', 0, ...
    'Value',       0);

addEntry(hTable, op_entry);
3 Check the validity of the operator entry.

• At the command prompt, invoke the table definition file.

tbl = crl_table_custom_add_ufix32
• In the Code Replacement Viewer, view the table definition file.

crviewer(crl_table_custom_add_ufix32)

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
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Scalar Operator Code Replacement
This example shows how to develop a code replacement library to optimize the performance of scalar
operators by providing information on how to define code replacement for a multiply operation. To
develop a code replacement library use either the interactive or programmatic approach. For more
information, see “Develop a Code Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_scalar. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Operation drop-down list, select Multiply.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input arguments, u1 and u2 with the Data Type of
double and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.

 Scalar Operator Code Replacement

68-99



9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:
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>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_scalar()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function .

function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.
function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                    'Key',                      'RTW_OP_MUL', ...
                    'Priority',                 90, ...
                    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
                    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
                    'ImplementationName',       'u8_mul_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_mul_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_mul_u8_u8.c' );

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.
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function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                    'Key',                      'RTW_OP_MUL', ...
                    'Priority',                 90, ...
                    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
                    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
                    'ImplementationName',       'u8_mul_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_mul_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_mul_u8_u8.c' );

%% Create the conceptual representation
arg = getTflArgFromString(hTable, 'y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'double');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTable, 'u2', 'double');
addConceptualArg(hEntry, arg );

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTable = crl_table_scalar()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                    'Key',                      'RTW_OP_MUL', ...
                    'Priority',                 90, ...
                    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
                    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
                    'ImplementationName',       'u8_mul_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_mul_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_mul_u8_u8.c' );

%% Create the conceptual representation
arg = getTflArgFromString(hTable, 'y1', 'double');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTable, 'u1', 'double');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTable, 'u2', 'double');
addConceptualArg(hEntry, arg );

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);
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%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_scalar
9 Create a registration file for the code replacement library with these specifications:

function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for scalar operator replacement';
this(1).TableList = {'crl_table_scalar.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Addition and Subtraction Operator Code Replacement” on page 68-104
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Addition and Subtraction Operator Code Replacement
This example shows how to develop a code replacement library to optimize the performance of
addition and subtraction operators by providing information on how to define code replacement for a
addition operator. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
68-13.

Algorithm Options
When creating a code replacement table entry for an addition or subtraction operator, first determine
the type of algorithm that your library function implements.

• Cast-before-operation (CBO), default — Prior to performing the addition or subtraction operation,
the algorithm type casts input values to the output type. If the output data type cannot exactly
represent the input values, losses can occur as a result of the cast to the output type. Additional
loss can occur when the result of the operation is cast to the final output type.

• Cast-after-operation (CAO) — The algorithm computes the ideal result of the addition or
subtraction operation of the two inputs. The algorithm then type casts the result to the output
data type. Loss occurs during the type cast. This algorithm behaves similarly to the C language
except when the signedness of the operands does not match. For example, when you add a signed
long operand to an unsigned long operand, standard C language rules convert the signed long
operand to an unsigned long operand. The result is a value that is not ideal.

Algorithm Classification
During code generation, the code generator examines addition and subtraction operations, including
adjacent type cast operations, to determine the type of algorithm to compute the expression result.
Based on the data types in the expression and the type of the accumulator (type used to hold the
result of the addition or subtraction operation), the code generator uses these rules.

• Floating-point types only

Input 1 Data
Type

Input 2 Data
Type

Accumulator Data
Type

Output Data Type Classificati
on

double double double double CBO, CAO
double double double single —
double double single double —
double double single single CBO
double single double double CBO, CAO
double single double single —
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Input 1 Data
Type

Input 2 Data
Type

Accumulator Data
Type

Output Data Type Classificati
on

double single single double —
double single single single CBO
single single single single CBO, CAO
single single single double —
single single double single —
single single double double CBO, CAO

• Floating-point and fixed-point types on the immediate addition or subtraction operation

Algorithm Conditions
CBO One of the following is true:

• Operation type is double.
• Operation type is single and input types are single or fixed-point.

CAO Operation type is a superset of input types—that is, output type can represent
values of input types without loss of data.

• Fixed-point types only

Algorithm Conditions
CBO At least one of the following is true:

• Accumulator type equals output type (Tacc == Tout).
• Output type is a superset of input types (Tacc >= {Tin1, Tin2}) and

accumulator type is a superset of output type (Tacc >= Tout).
• Operation does not incur range or precision loss.

CAO Net bias is zero and the data types in the expression have equal slope
adjustment factors. For more information on net bias, see “Addition” or
“Subtraction” in “Fixed-Point Operator Code Replacement” on page 68-134 (for
MATLAB code) or “Fixed-Point Operator Code Replacement” on page 67-169 (for
Simulink models).

In many cases, the numerical result of a CBO operation is equal to that of a CAO operation. For
example, if the input and output types are such that the operation produces the ideal result, as in the
case of int8 + int8 —> int16. To maximize the probability of code replacement occurring in such
cases, set the algorithm to cast-after-operation.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
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b In the right pane, name the table crl_table_addition. Click Apply.
3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Function drop-down list, select Addition. Algorithm

information appears in the crtool. For this example, select the parameter to Cast before
operation.

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of uint8 and the Argument Type of Scalar,
the input arguments, u1 and u2 with the Data Type of uint16 and the Argument Type of
Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.
function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                   'Key',                      'RTW_OP_ADD', ...
                   'EntryInfoAlgorithm',       'RTW_CAST_BEFORE_OP', ...
                   'ImplementationName',       'u8_add_cao_u16_u16');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.
function hTflTable = make_cbo_add_crl_table
% Create a function to call the code replacement library table 
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%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                   'Key',                      'RTW_OP_ADD', ...
                   'EntryInfoAlgorithm',       'RTW_CAST_BEFORE_OP', ...
                   'ImplementationName',       'u8_add_cao_u16_u16');

%% Create the conceptual representation
arg = getTflArgFromString(hTflTable, 'y1', 'uint8');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTflTable, 'u1', 'uint16');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTflTable, 'u2', 'uint16');
addConceptualArg(hEntry, arg );

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
copyConceptualArgsToImplementation. Add the complete entry to the table by calling the
function addEntry.
function hTflTable = make_cbo_add_crl_table()
% Create a function to call the code replacement library table 

%% Create a table object
hTflTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
                   'Key',                      'RTW_OP_ADD', ...
                   'EntryInfoAlgorithm',       'RTW_CAST_BEFORE_OP', ...
                   'ImplementationName',       'u8_add_cao_u16_u16');

%% Create the conceptual representation
arg = getTflArgFromString(hTflTable, 'y1', 'uint8');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);

arg = getTflArgFromString(hTflTable, 'u1', 'uint16');
addConceptualArg(hEntry, arg );

arg = getTflArgFromString(hTflTable, 'u2', 'uint16');
addConceptualArg(hEntry, arg );

%% Create the Implementation Representation
copyConceptualArgsToImplementation(hEntry);

%% Add the entry to the table
addEntry(hTflTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = make_cbo_add_crl_table
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9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for addition subtraction operator replacement’;
this(1).TableList = {'make_cbo_add_crl_table.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Limitations
• The code generator does not replace operations with nonzero net bias.
• When classifying an operation as a CAO operation, the code generator includes the adjacent casts

in the expression when the expression involves only fixed-point types. Otherwise, the code
generator classifies and replaces only the immediate addition or subtraction operation. Casts that
the code generator excludes from the classification appear in the generated code.

• To enable the code generator to include multiple cast operations, which follow an addition or
subtraction of fixed-point data, in the classification of an expression, the rounding mode must be
simplest or floor. Consider the expression y=(cast A)(cast B)(u1+u2). If the rounding
mode of (cast A), (cast B), and the addition operator (+) are set to simplest or floor, the
code generator takes into account (cast A) and (cast B) when classifying the expression and
performing the replacement only.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Scalar Operator Code Replacement” on page 68-99
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Small Matrix Operation to Processor Code Replacement
This example shows how to develop a code replacement library to optimize the performance of non-
scalar small matrix operations with processor-specific intrinsic functions by providing information on
how to define code replacement for a addition operator. To develop a code replacement library use
either the interactive or programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_small_matrix. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Function drop-down list, select Addition. Algorithm

information appears in the crtool. For this example, select the parameter to Cast before
operation.

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, with the Data Type of double and the Argument Type of
Matrix, the input argument, u1 with the Data Type of double and the Argument Type of
Matrix and the input argument, u2 with the Data Type of double and the Argument Type of
Matrix.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. Specify the return
argument y1, u1 and u2, with the Data Type of double and select the Pointer dialog box.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
     'Key',                      'RTW_OP_ADD', ...
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     'Priority',                 30, ...
     'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
     'ImplementationName',       'matrix_sum_2x2_double', ...
     'ImplementationHeaderFile', 'MatrixMath.h', ...
     'ImplementationSourceFile', 'MatrixMath.c', ...
     'ImplementationHeaderPath', LibPath, ...
     'ImplementationSourcePath', LibPath, ...
     'AdditionalIncludePaths',   {LibPath}, ...
     'GenCallback',              'RTW.copyFileToBuildDir', ...
     'SideEffects',              true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
     'Key',                      'RTW_OP_ADD', ...
     'Priority',                 30, ...
     'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
     'ImplementationName',       'matrix_sum_2x2_double', ...
     'ImplementationHeaderFile', 'MatrixMath.h', ...
     'ImplementationSourceFile', 'MatrixMath.c', ...
     'ImplementationHeaderPath', LibPath, ...
     'ImplementationSourcePath', LibPath, ...
     'AdditionalIncludePaths',   {LibPath}, ...
     'GenCallback',              'RTW.copyFileToBuildDir', ...
     'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString.
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function hTable = crl_table_small_matrix_operator()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
LibPath= fullfile(matlabroot,'examples','coder');

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
     'Key',                      'RTW_OP_ADD', ...
     'Priority',                 30, ...
     'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
     'ImplementationName',       'matrix_sum_2x2_double', ...
     'ImplementationHeaderFile', 'MatrixMath.h', ...
     'ImplementationSourceFile', 'MatrixMath.c', ...
     'ImplementationHeaderPath', LibPath, ...
     'ImplementationSourcePath', LibPath, ...
     'AdditionalIncludePaths',   {LibPath}, ...
     'GenCallback',              'RTW.copyFileToBuildDir', ...
     'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix',...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2]);

%% Create the Implementation Representation
arg = getTflArgFromString(hTable, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', ['double' '*']);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', ['double' '*']);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'y1', ['double' '*']);

arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.addArgument(arg);
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%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_small_matrix
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for small matrix operator to processor’;
this(1).TableList = {'crl_table_small_matrix.m'}; 
% table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Scalar Operator Code Replacement” on page 68-99
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Matrix Multiplication Operation to MathWorks BLAS Code
Replacement

You can develop a code replacement library for floating-point matrix/matrix and matrix/vector
multiplication operations with the multiplication functions dgemm and dgemv defined in the
MathWorks BLAS library. If you use a third-party BLAS library for replacement, you must change the
build requirements in this example to point to your library. To develop a code replacement library use
either the interactive or programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_blas. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Blas Operation
(Fortran).

4 Create entry parameters. In the Function drop-down list, select Multiply.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of
double and the Argument Type of Matrix.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. Set the BLAS level to
2(Vector).

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_blas
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflBlasEntryGenerator.
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
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%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_MUL', ...
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    'Priority',                 100, ...
    'ImplementationName',       'dgemm32', ...
    'ImplementationHeaderFile', 'blascompat32_crl.h', ...
    'ImplementationHeaderPath', fullfile('$(MATLAB_ROOT)','extern','include'), ...
    'AdditionalLinkObjs',       {['libmwblascompat32.' libExt]}, ...
    'AdditionalLinkObjsPaths',  {LibPath}, ...
    'SideEffects',              true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg. To specify a matrix argument in the function call, use the
argument class RTW.TflArgMatrix and specify the base type and the dimensions for which the
argument is valid. This type of table entry supports a range of dimensions specified in the format
[Dim1Min Dim2Min ... DimNMin; Dim1Max Dim2Max ... DimNMax]. For example, [2 2;
inf inf] means a two-dimensional matrix of size 2x2 or larger. The conceptual output argument for
the dgemm32 entry for matrix/matrix multiplication replacement specifies dimensions [2 2; inf
inf], while the conceptual output argument for the dgemv32 entry for matrix/vector
multiplication replacement specifies dimensions [2 1; inf 1].
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_MUL', ...
    'Priority',                 100, ...
    'ImplementationName',       'dgemm32', ...
    'ImplementationHeaderFile', 'blascompat32_crl.h', ...
    'ImplementationHeaderPath', fullfile('$(MATLAB_ROOT)','extern','include'), ...
    'AdditionalLinkObjs',       {['libmwblascompat32.' libExt]}, ...
    'AdditionalLinkObjsPaths',  {LibPath}, ...
    'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
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                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [1 1; inf inf]);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString. The example code configures special implementation arguments that
are required for dgemm and dgemv function replacements. The convenience methods setReturn
and addArgument specify whether an argument is a return value or argument and adds the
argument to the entry’s array of implementation arguments. Add the complete entry to the table
by calling the function addEntry.
function hTable = crl_table_blas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path for Windows or UNIX block%%%%%%%%%%%%%%%%%%

arch = computer('arch');
if ~ispc
    LibPath = fullfile('$(MATLAB_ROOT)', 'bin', arch);
else
    % Use Stateflow to get the compiler info
    compilerInfo = sf('Private','compilerman','get_compiler_info');
    compilerName = compilerInfo.compilerName;
    if strcmp(compilerName, 'msvc90') || ...
            strcmp(compilerName, 'msvc80') || ...
            strcmp(compilerName, 'msvc71') || ...
            strcmp(compilerName, 'msvc60'), ...
            compilerName = 'microsoft';
    end
    LibPath = fullfile('$(MATLAB_ROOT)', 'extern', 'lib', arch, compilerName);
end

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

%%%%%%Beginning of entries for the first dgemm block%%%%%%%%%%%%%%%%%%

% Create table entry for dgemm32
hEntry = RTW.TflBlasEntryGenerator;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_MUL', ...
    'Priority',                 100, ...
    'ImplementationName',       'dgemm32', ...
    'ImplementationHeaderFile', 'blascompat32_crl.h', ...
    'ImplementationHeaderPath', fullfile('$(MATLAB_ROOT)','extern','include'), ...
    'AdditionalLinkObjs',       {['libmwblascompat32.' libExt]}, ...
    'AdditionalLinkObjsPaths',  {LibPath}, ...
    'SideEffects',              true);

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'y1', ...
                          'IOType',       'RTW_IO_OUTPUT', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
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                          'Name',         'u1', ...
                          'BaseType',     'double', ...
                          'DimRange',     [2 2; inf inf]);
createAndAddConceptualArg(hEntry, 'RTW.TflArgMatrix', ...
                          'Name',         'u2', ...
                          'BaseType',     'double', ...
                          'DimRange',     [1 1; inf inf]);

%% Create the Implementation Representation
% Using RTW.TflBlasEntryGenerator for xgemm requires the following
% implementation signature:
%
% void f(char* TRANSA, char* TRANSB, int* M, int* N, int* K,
%        type* ALPHA, type* u1, int* LDA, type* u2, int* LDB,
%        type* BETA, type* y, int* LDC)
%
% When a match occurs, the code generator computes the
% values for M, N, K, LDA, LDB, and LDC and inserts them into the
% generated code. TRANSA and TRANSB are set to 'N'.

% Specify replacement function signature

arg = getTflArgFromString(hTable, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg);

arg = RTW.TflArgCharConstant('TRANSA');
% Possible values for PassByType property are
%  RTW_PASSBY_AUTO, RTW_PASSBY_POINTER,
%  RTW_PASSBY_VOID_POINTER, RTW_PASSBY_BASE_POINTER
arg.PassByType = 'RTW_PASSBY_POINTER';
hEntry.Implementation.addArgument(arg);

arg = RTW.TflArgCharConstant('TRANSB');
arg.PassByType = 'RTW_PASSBY_POINTER';
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'M', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'N', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'K', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'ALPHA', 'double', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u1', ['double' '*']);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'LDA', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', ['double' '*']);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'LDB', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'BETA', 'double', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);
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arg = getTflArgFromString(hTable, 'y1', ['double' '*']);
arg.IOType = 'RTW_IO_OUTPUT';
arg.PassByType = 'RTW_PASSBY_POINTER';
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'LDC', 'integer', 0);
arg.PassByType = 'RTW_PASSBY_POINTER';
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_blas

9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for matrix multiplication for Mathworks Blas code’;
this(1).TableList = {'crl_table_blas.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations

10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Matrix Multiplication Operation to ANSI/ISO C BLAS Code Replacement” on page 68-125
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Matrix Multiplication Operation to ANSI/ISO C BLAS Code
Replacement

You can develop a code replacement library for floating-point matrix/matrix and matrix/vector
multiplication operations with the multiplication functions sgemm defined in the MathWorks C BLAS
library. Use a third-party C BLAS library for replacement and change the build requirements in this
example to point to your library. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_cblas. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > CBlas Operation
(Atlas).

4 Create entry parameters. In the Function drop-down list, select Multiply.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of single
and the Argument Type of Matrix.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. Set the BLAS level to
3(Vector).

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_cblas
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCBlasEntryGenerator.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
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%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters( ...
    'Key', 'RTW_OP_MUL', ...
    'Priority', 100, ...
    'ImplementationName', 'cblas_sgemm', ...
    'ImplementationSourceFile', 'ccblas.c', ...
    'ImplementationHeaderFile', 'ccblas.h', ...
    'AdditionalIncludePaths',   {LibPath}, ...
    'AdditionalLinkObjs',       {['libcblas' libExt]}, ...
    'AdditionalLinkFlags',        {'-lgfortran'},...
    'SideEffects', true);

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg. To specify a matrix argument in the function call, use the
argument class RTW.TflArgMatrix and specify the base type and the dimensions for which the
argument is valid. This type of table entry supports a range of dimensions specified in the format
[Dim1Min Dim2Min ... DimNMin; Dim1Max Dim2Max ... DimNMax]. For example, [2 2;
inf inf] means a two-dimensional matrix of size 2x2 or larger.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
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    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters( ...
    'Key', 'RTW_OP_MUL', ...
    'Priority', 100, ...
    'ImplementationName', 'cblas_sgemm', ...
    'ImplementationSourceFile', 'ccblas.c', ...
    'ImplementationHeaderFile', 'ccblas.h', ...
    'AdditionalIncludePaths',   {LibPath}, ...
    'AdditionalLinkObjs',       {['libcblas' libExt]}, ...
    'AdditionalLinkFlags',      {'-lgfortran'},...
    'SideEffects', true);

%% Create the conceptual representation
arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'single');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'single');
arg.DimRange = [2 1; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'single');
arg.DimRange = [1 2; Inf Inf];
hEnt.addConceptualArg(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
getTflArgFromString. The example code configures special implementation arguments that
are required for dgemm and dgemv function replacements. The convenience methods setReturn
and addArgument specify whether an argument is a return value or argument and adds the
argument to the entry’s array of implementation arguments. Add the complete entry to the table
by calling the function addEntry.
function hTable = crl_table_cblas
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
%%%%%%%%%%%% Define library path Cblas library file%%%%%%%%%%%%%%%%%%

LibPath = fullfile('<Specify the path of your cblas library>');

if ispc
    libExt = 'lib';
elseif ismac
    libExt = 'dylib';
else
    libExt = 'so';
end

% Create table entry for dgemm32
hEntry = RTW.TflCBlasEntryGenerator;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters( ...
    'Key', 'RTW_OP_MUL', ...
    'Priority', 100, ...
    'ImplementationName', 'cblas_sgemm', ...
    'ImplementationSourceFile', 'ccblas.c', ...
    'ImplementationHeaderFile', 'ccblas.h', ...
    'AdditionalIncludePaths',   {LibPath}, ...
    'AdditionalLinkObjs',       {['libcblas' libExt]}, ...
    'AdditionalLinkFlags',      {'-lgfortran'},...
    'SideEffects', true);

%% Create the conceptual representation
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arg = RTW.TflArgMatrix('y1', 'RTW_IO_OUTPUT',  'single');
arg.DimRange = [2 2; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u1', 'RTW_IO_INPUT',  'single');
arg.DimRange = [2 1; Inf Inf];
hEnt.addConceptualArg(arg);

arg = RTW.TflArgMatrix('u2', 'RTW_IO_INPUT',  'single');
arg.DimRange = [1 2; Inf Inf];
hEnt.addConceptualArg(arg);

%% Create the Implementation Representation
% Using RTW.TflCBlasEntryGenerator for sgemm requires the following
% implementation signature:
%
% void no_name( const integer ORDER, const integer TRANSA, const integer TRANSB, 
% const integer M, const integer N, const integer K, const double ALPHA, 
% const double* u1, const integer LDA, const double* u2, const integer LDB, 
% const double BETA, double* y1, const integer LDC );
%
% When a match occurs, the code generator computes the
% values for M, N, K, LDA, LDB, and LDC and inserts them into the
% generated code. TRANSA and TRANSB are set to 'N'.

% Specify replacement function signature
arg = hEntry.getTflArgFromString('y2','void');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.setReturn(arg); 

arg = hEntry.getTflArgFromString('ORDER','integer',102.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('TRANSA','integer',111.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('TRANSB','integer',111.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('M','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('N','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('K','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('ALPHA','double',1.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u1','single*');
arg.Type.BaseType.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('LDA','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('u2','single*');
arg.Type.BaseType.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('LDB','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('BETA','double',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

arg = hEntry.getTflArgFromString('y1','single*');
arg.IOType = 'RTW_IO_OUTPUT';
hEntry.Implementation.addArgument(arg);
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arg = hEntry.getTflArgFromString('LDC','integer',0.000000000000000);
arg.Type.ReadOnly = true;
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_cblas
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for matrix multiplication for Mathworks CBlas code’;
this(1).TableList = {'crl_table_cblas.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Matrix Multiplication Operation to MathWorks BLAS Code Replacement” on page 68-117
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Remap Operator Output to Function Input
If your generated code must meet a specific coding pattern or you want more flexibility, for example,
to further improve performance, you can remap operator outputs to input positions in an
implementation function argument list.

Note Remapping outputs to implementation function inputs is supported only for operator
replacement.

For example, for a sum operation, the code generator produces code similar to:

add8_Y.Out1 = u8_add_u8_u8(add8_U.In1, add8_U.In2);

If you remap the output to the first input, the code generator produces code similar to:

u8_add_u8_u8(&add8_Y.Out1;, add8_U.In1, add8_U.In2);

The following table definition file for a sum operation remaps operator output y1 as the first function
input argument.

1 Create a table definition file that contains a function definition. For example:

function hTable = crl_table_add_uint8
2 Within the function body, create the table by calling the function RTW.TflTable.

hTable = RTW.TflTable;
3 Create an entry for the operator mapping with a call to the RTW.TflCOperationEntry

function.

% Create operation entry 
op_entry = RTW.TflCOperationEntry;

4 Set operator entry parameters with a call to the setTflCOperationEntryParameters
function. In the function call, set the property SideEffects to true.
setTflCOperationEntryParameters(op_entry, ...
                    'Key',                      'RTW_OP_ADD', ...
                    'Priority',                 90, ...
                    'ImplementationName',       'u8_add_u8_u8', ...
                    'ImplementationHeaderFile', 'u8_add_u8_u8.h', ...
                    'ImplementationSourceFile', 'u8_add_u8_u8.c', ...
                    'SideEffects',              true );

5 Create conceptual arguments y1, u1, and u2. There are multiple ways to set up the conceptual
arguments. This example uses calls to the getTflArgFromString and addConceptualArg
functions to create and add the arguments.
arg = getTflArgFromString(hTable, 'y1', 'uint8');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(op_entry, arg);

arg = getTflArgFromString(hTable, 'u1', 'uint8');
addConceptualArg(op_entry, arg );

arg = getTflArgFromString(hTable, 'u2', 'uint8');
addConceptualArg(op_entry, arg );

6 Create the implementation arguments. There are multiple ways to set up the implementation
arguments. This example uses calls to the getTflArgFromString function to create the
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arguments. When defining the implementation function return argument, create a new void
output argument, for example, y2. When defining the implementation function argument for the
conceptual output argument (y1), set the operator output argument as an additional input
argument. Mark its IOType as output. Make its type a pointer type. The convenience methods
setReturn and addArgument specify whether an argument is a return value or argument and
adds the argument to the entry’s array of implementation arguments.
% Create new void output y2
arg = getTflArgFromString(hTable, 'y2', 'void');
arg.IOType = 'RTW_IO_OUTPUT';
op_entry.Implementation.setReturn(arg);

% Set y1 as first input arg, mark IOType as output, and use pointer type
arg=getTflArgFromString(hTable, 'y1', 'uint8*');
arg.IOType = 'RTW_IO_OUTPUT';
op_entry.Implementation.addArgument(arg);

arg=getTflArgFromString(hTable, 'u1', 'uint8');
op_entry.Implementation.addArgument(arg);

arg=getTflArgFromString(hTable, 'u2', 'uint8');
op_entry.Implementation.addArgument(arg);

7 Add the entry to a code replacement table with a call to the addEntry function.

addEntry(hTable, op_entry);
8 Save the table definition file. Use the name of the table definition function to name the file.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
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Fixed-Point Operator Code Replacement
If you have a Fixed-Point Designer license, you can define fixed-point operator code replacement
entries to match:

• A binary-point-only scaling combination on the operator inputs and output.
• A slope bias scaling combination on the operator inputs and output.
• Relative scaling or net slope between multiplication or division operator inputs and output. Use

one of these methods to map a range of slope and bias values to a replacement function for
multiplication or division.

• Equal slope and zero net bias across addition or subtraction operator inputs and output. Use this
method to disregard specific slope and bias values and map relative slope and bias values to a
replacement function for addition or subtraction.

Common Ways to Match Fixed-Point Operator Entries
The following table maps common ways to match fixed-point operator code replacement entries with
the associated fixed-point parameters that you specify in a code replacement table definition file.

Match Create entry Minimally specify parameters
A specific binary-point-only
scaling combination on the
operator inputs and output.

RTW.TflCOperationEntry createAndAddConceptualArg function:

• CheckSlope: Specify the value true.
• CheckBias: Specify the value true.
• DataTypeMode (or DataType/Scaling

equivalent): Specify fixed-point binary-
point-only scaling.

• FractionLength: Specify a fraction
length (for example, 3).

A specific slope bias scaling
combination on the operator
inputs and output.

RTW.TflCOperationEntry createAndAddConceptualArg function:

• CheckSlope: Specify the value true.
• CheckBias: Specify the value true.
• DataTypeMode (or DataType/Scaling

equivalent): Specify fixed-point [slope
bias] scaling.

• Slope (or SlopeAdjustmentFactor/ ‐
FixedExponent equivalent): Specify a
slope value (for example, 15).

• Bias: Specify a bias value (for example,
2).

68 Code Replacement Customization for MATLAB Code

68-134



Match Create entry Minimally specify parameters
Net slope between operator
inputs and output
(multiplication and division).

RTW.TflCOperationEntry‐
Generator_NetSlope

setTflCOperationEntryParameters
function:

• NetSlopeAdjustmentFactor: Specify
the slope adjustment factor (F) part of
the net slope, F2E (for example, 1.0).

• NetFixedExponent: Specify the fixed
exponent (E) part of the net slope, F2E
(for example, -3.0).

createAndAddConceptualArg function:

• CheckSlope: Specify the value false.
• CheckBias: Specify the value false.
• DataType: Specify the value 'Fixed'.

Relative scaling between
operator inputs and output
(multiplication and division).

RTW.TflCOperationEntry‐
Generator

setTflCOperationEntryParameters
function:

• RelativeScalingFactorF: Specify the
slope adjustment factor (F) part of the
relative scaling factor, F2E (for example,
1.0).

• RelativeScalingFactorE: Specify the
fixed exponent (E) part of the relative
scaling factor, F2E (for example, -3.0).

createAndAddConceptualArg function:

• CheckSlope: Specify the value false.
• CheckBias: Specify the value false.
• DataType: Specify the value 'Fixed'.

Equal slope and zero net bias
across operator inputs and
output (addition and
subtraction).

RTW.TflCOperationEntry‐
Generator

setTflCOperationEntryParameters
function:

• SlopesMustBeTheSame: Specify the
value true.

• MustHaveZeroNetBias: Specify the
value true.

createAndAddConceptualArg function:

• CheckSlope: Specify the value false.
• CheckBias: Specify the value false.

Fixed-Point Numbers and Arithmetic
Fixed-point numbers use integers and integer arithmetic to represent real numbers and arithmetic
with the following encoding scheme:
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V = V = SQ + B

• V is an arbitrarily precise real-world value.
• V is the approximate real-world value that results from fixed-point representation.
• Q is an integer that encodes V, referred to as the quantized integer.
• S is a coefficient of Q, referred to as the slope.
• B is an additive correction, referred to as the bias.

The general equation for an operation between fixed-point operands is:

SOQO + BO = S1Q1 + B1 < op > (S2Q2 + B2)

The objective of fixed-point operator replacement is to replace an operator that accepts and returns
fixed-point or integer inputs and output with a function that accepts and returns built-in C numeric
data types. The following sections provide additional programming information for each supported
operator.

Addition
The operation V0 = V1 + V2 implies that

Q0 =
S1
S0

Q1 +
S2
S0

Q2 +
B1 + B2− B0

S0

If an addition replacement function is defined such that the scaling on the operands and sum are
equal and the net bias

B1 + B2− B0
S0

is zero (for example, a function s8_add_s8_s8 that adds two signed 8-bit values and produces a
signed 8-bit result), then the operator entry must set the operator entry parameters
SlopesMustBeTheSame and MustHaveZeroNetBias to true. To match for replacement, the slopes
must be the same for all addition conceptual arguments. (For parameter descriptions, see the
reference page for the function setTflCOperationEntryParameters.)

Subtraction
The operation V0 = V1 − V2 implies that

Q0 =
S1
S0

Q1−
S2
S0

Q2 +
B1− B2− B0

S0

If a subtraction replacement function is defined such that the scaling on the operands and difference
are equal and the net bias

B1− B2− B0
S0

is zero (for example, a function s8_sub_s8_s8 that subtracts two signed 8-bit values and produces a
signed 8-bit result), then the operator entry must set the operator entry parameters
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SlopesMustBeTheSame and MustHaveZeroNetBias to true. To match for replacement, the slopes
must be the same for all subtraction conceptual arguments. (For parameter descriptions, see the
reference page for the function setTflCOperationEntryParameters.)

Multiplication
There are different ways to specify multiplication replacements. The most direct way is to specify an
exact match of the input and output types. This is feasible if a model contains only a few known slope
and bias combinations. Use the TflCOperationEntry class and specify the exact values of slope
and bias on each argument. For scenarios where there are numerous slope/bias combinations, it is
not feasible to specify each value with a different entry. Use a net slope entry or create a custom
entry.

The operation V0 = V1 * V2 implies, for binary-point-only scaling, that

S0Q0 = S1Q1 S2Q2

Q0 =
S1S2
S0

Q1Q2

Q0 = SnQ1Q2

where Sn is the net slope.

It is common to replace all multiplication operations that have a net slope of 1.0 with a function that
performs C-style multiplication. For example, to replace all signed 8-bit multiplications that have a
net scaling of 1.0 with the s8_mul_s8_u8_ replacement function, the operator entry must define a
net slope factor, F2E. You specify the values for F and E using operator entry parameters
NetSlopeAdjustmentFactor and NetFixedExponent. For the s8_mul_s8_u8 function, set
NetSlopeAdjustmentFactor to 1 and NetFixedExponent to 0.0. Also, set the operator entry
parameter SlopesMustBeTheSame to false and the parameter MustHaveZeroNetBias to true.
To match for replacement, the biases must be zero for all multiplication conceptual arguments. (For
parameter descriptions, see the reference page for the function
setTflCOperationEntryParameters.)

Note When an operator entry specifies NetSlopeAdjustmentFactor and NetFixedExponent,
matching entries must have arguments with zero bias.

Division
There are different ways to specify division replacements. The most direct way is to specify an exact
match of the input and output types. This is feasible if a model contains only a few known slope and
bias combinations. Use the TflCOperationEntry class and specify the exact values of slope and
bias on each argument. For scenarios where there are numerous slope/bias combinations, it is not
feasible to specify each value with a different entry. Use a net slope entry or create a custom entry
(see “Customize Match and Replacement Process” on page 67-118).

The operation V0 = (V1 / V2) implies, for binary-point-only scaling, that

S0Q0 =
S1Q1
S2Q2

Q0 = Sn
Q1
Q2
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where Sn is the net slope.

It is common to replace all division operations that have a net slope of 1.0 with a function that
performs C-style division. For example, to replace all signed 8-bit divisions that have a net scaling of
1.0 with the s8_mul_s8_u8_ replacement function, the operator entry must define a net slope factor,
F2E. You specify the values for F and E using operator entry parameters
NetSlopeAdjustmentFactor and NetFixedExponent. For the s16_netslope0p5_div_s16_s16
function, you would set NetSlopeAdjustmentFactor to 1 and NetFixedExponent to 0.0. Also, set
the operator entry parameter SlopesMustBeTheSame to false and the parameter
MustHaveZeroNetBias to true. To match for replacement, the biases must be zero for all division
conceptual arguments. (For parameter descriptions, see the reference page for the function
setTflCOperationEntryParameters.)

Note When an operator entry specifies NetSlopeAdjustmentFactor and NetFixedExponent,
matching entries must have arguments with zero bias.

Data Type Conversion (Cast)
The data type conversion operation V0 = V1 implies, for binary-point-only scaling, that

Q0 =
S1
S0

Q1

Q0 = SnQ1

where Sn is the net slope. Set the operator entry parameter SlopesMustBeTheSame to false and
the parameter MustHaveZeroNetBias to true. To match for replacement, the biases must be zero
for all cast conceptual arguments. (For parameter descriptions, see the reference page for the
function setTflCOperationEntryParameters.)

Shift
The shift left or shift right operation V0 = (V1 / 2n) implies, for binary-point-only scaling, that

S0Q0 =
S1Q1

2n

Q0 =
S1
S0

Q1

2n

Q0 = Sn
Q1

2n

where Sn is the net slope. Set the operator entry parameter SlopesMustBeTheSame to false and
the parameter MustHaveZeroNetBias to true. To match for replacement, the biases must be zero
for all shift conceptual arguments. (For parameter descriptions, see the reference page for the
function setTflCOperationEntryParameters.)
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See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Binary-Point-Only Scaling Code Replacement” on page 68-140
• “Slope Bias Scaling Code Replacement” on page 68-145
• “Net Slope Scaling Code Replacement” on page 68-151
• “Equal Slope and Zero Net Bias Code Replacement” on page 68-158
• “Data Type Conversions (Casts) and Operator Code Replacement” on page 68-164
• “Shift Left Operations and Code Replacement” on page 68-170
• “Remap Operator Output to Function Input” on page 68-132
• “Customize Match and Replacement Process” on page 68-93
• “Develop a Code Replacement Library” on page 68-13
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Binary-Point-Only Scaling Code Replacement
You can define code replacement entries for operations on fixed-point data types such that they match
a binary-point-only scaling combination of operator inputs and output. This example shows how to
develop a code replacement library to optimize the performance of fixed point data type operations by
providing information that maps a binary point scale entry to a addition operator. To develop a code
replacement library use only the programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 68-13.

This example modifies a fixed-point addition replacement such that the implementation function
passes in the fraction lengths of the input and output data types as arguments.

To create custom code replacement entries that add logic to the code replacement match and
replacement process see “Customize Code Match and Replacement for Scalar Operations” on page
67-124. You can create and add three additional implementation function arguments for passing
fraction lengths in the class definition or in each code replacement entry definition that instantiates
this class. This example creates the arguments, adds them to a code replacement table definition file,
and sets them to specific values in the class definition code.
classdef TflCustomOperationEntryBinaryPoint < RTW.TflCOperationEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok

      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This class will check additional data and can
      % modify the implementation function.

      % The base class checks word size and signedness. Slopes and biases
      % have been wildcarded, so the only additional checking to do is
      % to check that the biases are zero and that there are only three
      % conceptual arguments (one output, two inputs)

      ent = []; % default the return to empty, indicating the match failed

      if length(hCSO.ConceptualArgs) == 3 && ...
          hCSO.ConceptualArgs(1).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(2).Type.Bias == 0 && ...
          hCSO.ConceptualArgs(3).Type.Bias == 0

        % Modify the default implementation. Since this is a
        % generator entry, a concrete entry is created using this entry
        % as a template. The type of entry being created is a standard
        % TflCOperationEntry. Using the standard operation entry
        % provides required information, and you do not need
        % a custom match function.
        ent = RTW.TflCOperationEntry(hThis);

        % Since this entry is modifying the implementation for specific
        % fraction-length values (arguments 3, 4, and 5), the conceptual argument
        % wild cards must be removed (the wildcards were inherited from the
        % generator when it was used as a template for the concrete entry).
        % This concrete entry is now for a specific slope and bias. 
        % hCSO holds the slope and bias values (created by the code generator).
        for idx=1:3
          ent.ConceptualArgs(idx).CheckSlope = true;
          ent.ConceptualArgs(idx).CheckBias = true;

          % Set the specific Slope and Biases
          ent.ConceptualArgs(idx).Type.Slope = hCSO.ConceptualArgs(idx).Type.Slope;
          ent.ConceptualArgs(idx).Type.Bias = 0;
        end

        % Set the fraction-length values in the implementation function.
        ent.Implementation.Arguments(3).Value = ...
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           -1.0*hCSO.ConceptualArgs(2).Type.FixedExponent;
        ent.Implementation.Arguments(4).Value = ...
           -1.0*hCSO.ConceptualArgs(3).Type.FixedExponent;
        ent.Implementation.Arguments(5).Value = ...
           -1.0*hCSO.ConceptualArgs(1).Type.FixedExponent;
      end
    end
  end
end

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_fixed_binptscale()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the custom entry function .

function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.

function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_binarypoint', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.
function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_binarypoint', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'BinaryPoint', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'BinaryPoint', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'BinaryPoint', ...
       'IsSigned',   false, ...
       'WordLength', 32);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
createAndSetCImplementationReturn and createAndAddImplementationArg. Add the
complete entry to the table by calling the function addEntry.
function hTable = crl_table_fixed_binptscale()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntryBinaryPoint;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_binarypoint', ...
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    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'BinaryPoint', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'BinaryPoint', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'BinaryPoint', ...
       'IsSigned',   false, ...
       'WordLength', 32);

%% Create the implementation Representation
% Specify replacement function signature
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 3 fraction-length args. Actual values are set during code generation.
createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'fl_out', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);
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%% Add the entry to the table
hTable.addEntry(op_entry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_fixed_binptscale
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for binary point scaling CRL’;
this(1).TableList = {'crl_table_fixed_binptscale.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Slope Bias Scaling Code Replacement” on page 68-145
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Slope Bias Scaling Code Replacement
You can define code replacement for operations on fixed-point data types as matching a slope bias
scaling combination on the operator inputs and output. This example shows how to develop a code
replacement library to optimize the performance of fixed point data type operations by providing
information on how to define code replacement for a division operator. To develop a code
replacement library use only the programmatic approach. For more information, see “Develop a Code
Replacement Library” on page 68-13.

This example modifies a fixed-point addition replacement such that the implementation function
passes in the fraction lengths of the input and output data types as arguments.

To create custom code replacement entries that add logic to the code replacement match and
replacement process, see “Customize Code Match and Replacement for Scalar Operations” on page
67-124. You can create and add three additional implementation function arguments for passing
fraction lengths in the class definition or in each code replacement entry definition that instantiates
this class. This example creates the arguments, adds them to a code replacement table definition file,
and sets them to specific values in the class definition code.
classdef TflCustomOperationEntrySlopeBias < RTW.TflCOperationEntryML
  methods
    function ent = do_match(hThis, ...
        hCSO, ... %#ok
        targetBitPerChar, ... %#ok
        targetBitPerShort, ... %#ok
        targetBitPerInt, ... %#ok
        targetBitPerLong, ... %#ok
        targetBitPerLongLong) %#ok

      % DO_MATCH - Create a custom match function. The base class
      % checks the types of the arguments prior to calling this
      % method. This class will check additional data and can
      % modify the implementation function.

      % The base class checks word size and signedness. Slopes and biases
      % have been wildcarded, so the only additional checking to do is
      % to check that the biases are zero and that there are only three
      % conceptual arguments (one output, two inputs)

      ent = []; % default the return to empty, indicating the match failed

      if length(hCSO.ConceptualArgs) == 3

        % Modify the default implementation. Since this is a
        % generator entry, a concrete entry is created using this entry
        % as a template. The type of entry being created is a standard
        % TflCOperationEntry. Using the standard operation entry
        % provides required information, and you do not need
        % a custom match function.
        ent = RTW.TflCOperationEntry(hThis);

        % Since this entry is modifying the implementation for specific
        % fraction-length values (arguments 3, 4, and 5), the conceptual argument
        % wild cards must be removed (the wildcards were inherited from the
        % generator when it was used as a template for the concrete entry).
        % This concrete entry is now for a specific slope and bias. 
        % hCSO holds the slope and bias values (created by the code generator).
        for idx=1:3
          ent.ConceptualArgs(idx).CheckSlope = true;
          ent.ConceptualArgs(idx).CheckBias = true;

          % Set the specific Slope and Biases
          ent.ConceptualArgs(idx).Type.Slope = hCSO.ConceptualArgs(idx).Type.Slope;
          ent.ConceptualArgs(idx).Type.Bias = hCSO.ConceptualArgs(idx).Type.Bias;
        end

        % Set the Slope and Bias values in the implementation function.
        ent.Implementation.Arguments(3).Value = hCSO.ConceptualArgs(2).Type.Slope;
        ent.Implementation.Arguments(4).Value = hCSO.ConceptualArgs(2).Type.Bias;
        ent.Implementation.Arguments(5).Value = hCSO.ConceptualArgs(3).Type.Slope;
        ent.Implementation.Arguments(6).Value = hCSO.ConceptualArgs(3).Type.Bias;
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        ent.Implementation.Arguments(7).Value = hCSO.ConceptualArgs(1).Type.Slope;
        ent.Implementation.Arguments(8).Value = hCSO.ConceptualArgs(1).Type.Bias;
      end
    end
  end
end

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the custom entry function .

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_slopebias', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');
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5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
createAndAddConceptualArg.

function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_slopebias', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'SlopeBias', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'SlopeBias', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'SlopeBias', ...
       'IsSigned',   false, ...
       'WordLength', 32);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
same order and properties as the conceptual arguments, call the function
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createAndSetCImplementationReturn and createAndAddImplementationArg. Add the
complete entry to the table by calling the function addEntry.
function hTable = crl_table_custom_add_ufix32_slopebias
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = TflCustomOperationEntrySlopeBias;;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_ADD', ...
    'Priority',                 30, ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationName',       'myFixptAdd_slopebias', ...
    'ImplementationHeaderFile', 'myFixptAdd.h', ...
    'ImplementationSourceFile', 'myFixptAdd.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
     'Name',       'y1', ...
     'IOType',     'RTW_IO_OUTPUT', ...
     'CheckSlope', false, ...
     'CheckBias',  false, ...
     'DataType',   'Fixed', ...
     'Scaling',    'SlopeBias', ...
     'IsSigned',   false, ...
     'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
      'Name',       'u1', ...
      'IOType',     'RTW_IO_INPUT', ...
      'CheckSlope', false, ...
      'CheckBias',  false, ...
      'DataType',   'Fixed', ...
      'Scaling',    'SlopeBias', ...
      'IsSigned',   false, ...
      'WordLength', 32);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
       'Name',       'u2', ...
       'IOType',     'RTW_IO_INPUT', ...
       'CheckSlope', false, ...
       'CheckBias',  false, ...
       'DataType',   'Fixed', ...
       'Scaling',    'SlopeBias', ...
       'IsSigned',   false, ...
       'WordLength', 32);

%% Create the implementation Representation
% Specify replacement function signature
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 3 fraction-length args. Actual values are set during code generation.
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'y1', ...
    'IOType',     'RTW_IO_OUTPUT', ...
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    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',       'u2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0);

% Add 6 args for slopes and biases. 
% Actual values are set during code generation.
createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'slope_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'bias_in1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   true, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'slope_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'bias_in2', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   true, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'slope_out1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   false, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumericConstant', ...
    'Name',       'bias_out1', ...
    'IOType',     'RTW_IO_INPUT', ...
    'IsSigned',   true, ...
    'WordLength', 32, ...
    'FractionLength', 0, ...
    'Value',       0);

addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_custom_add_ufix32_slopebias
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9 Register the code replacement library. Registration creates a code replacement library by
defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for slope bias scaling function replacement’;
this(1).TableList = {'crl_table_custom_add_ufix32_slopebias.m'}; 
% table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Binary-Point-Only Scaling Code Replacement” on page 68-140
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Net Slope Scaling Code Replacement
You can define code replacement entries for multiplication and division operations on fixed-point data
types such that they match the net slope between operator inputs and output. The net slope entries
can map a range of slope and bias values to a replacement function for multiplication or division.

This example shows how to develop a code replacement library to optimize the performance of fixed
point net slope operations by providing information on how to define code replacement for a divide
operation. To develop a code replacement library use either the interactive or programmatic
approach. For more information, see “Develop a Code Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_netslopeScaling. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Fixed Point Net
Slope Operation.

4 Create entry parameters. In the Operation drop-down list, select Divide.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of
fixdt(true,16,*,*) and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. In the Function arguments subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of int
16. Also set the Net slope Adjustment Factor as 1 and Net Fixed Exponent as 0.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
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more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntryGenerator_NetSlope.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

4 Set operator entry parameters with a call to the setTflCOperationEntryParameters
function. The parameters specify the type of operation as division, the saturation mode as wrap
on overflow, rounding modes as unspecified, and the name of the replacement function as
user_div_*. NetSlopeAdjustmentFactor and NetFixedExponent specify the F and E parts
of the net slope F2E.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
   'Key',                      'RTW_OP_DIV', ...
   'Priority',                 90, ...
   'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
   'RoundingModes',            {'RTW_ROUND_CEILING'}, ...
   'NetSlopeAdjustmentFactor',   1.0, ...
   'NetFixedExponent',           0.0, ...
   'ImplementationName',       's16_div_s16_s16', ...
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   'ImplementationHeaderFile', 's16_div_s16_s16.h', ...
   'ImplementationSourceFile', 's16_div_s16_s16.c');

5 Create conceptual arguments y1, u1, and u2. This example uses calls to the
createAndAddConceptualArg function to create and add an argument with one function call.
Specify each argument as fixed-point, 16 bits, and signed. Also, for each argument, specify that
code replacement request processing does not check for an exact match to the call-site slope and
bias values.

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
   'Key',                      'RTW_OP_DIV', ...
   'Priority',                 90, ...
   'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
   'RoundingModes',            {'RTW_ROUND_CEILING'}, ...
   'NetSlopeAdjustmentFactor',   1.0, ...
   'NetFixedExponent',           0.0, ...
   'ImplementationName',       's16_div_s16_s16', ...
   'ImplementationHeaderFile', 's16_div_s16_s16.h', ...
   'ImplementationSourceFile', 's16_div_s16_s16.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'y1', ...
   'IOType',         'RTW_IO_OUTPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u1', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u2', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);
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6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. This example uses calls to the
createAndSetCImplementationReturn and createAndAddImplementationArg functions
to create and add implementation arguments to the entry. Implementation arguments must
describe fundamental numeric data types (not fixed-point data types). In this case, the output and
input arguments are 16 bits and signed (int16).

function hTable = crl_table_netslopeScaling
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
   'Key',                      'RTW_OP_DIV', ...
   'Priority',                 90, ...
   'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
   'RoundingModes',            {'RTW_ROUND_CEILING'}, ...
   'NetSlopeAdjustmentFactor',   1.0, ...
   'NetFixedExponent',           0.0, ...
   'ImplementationName',       's16_div_s16_s16', ...
   'ImplementationHeaderFile', 's16_div_s16_s16.h', ...
   'ImplementationSourceFile', 's16_div_s16_s16.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'y1', ...
   'IOType',         'RTW_IO_OUTPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u1', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
   'Name',           'u2', ...
   'IOType',         'RTW_IO_INPUT', ...
   'CheckSlope',     false, ...
   'CheckBias',      false, ...
   'DataType',       'Fixed', ...
   'IsSigned',       true, ...
   'WordLength',     16);

%% Create the Implementation Representation
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createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
                              'Name',           'y1', ...
                              'IOType',         'RTW_IO_OUTPUT', ...
                              'IsSigned',       true, ...
                              'WordLength',     16, ...
                              'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
                              'Name',           'u1', ...
                              'IOType',         'RTW_IO_INPUT', ...
                              'IsSigned',       true, ...
                              'WordLength',     16, ...
                              'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
                              'Name',           'u2', ...
                              'IOType',         'RTW_IO_INPUT', ...
                              'IsSigned',       true, ...
                              'WordLength',     16, ...
                              'FractionLength', 0);

%% Add the entry to the table
addEntry(hTable, hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_netslopeScaling
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file by using these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for net slope scaling’;
this(1).TableList = {'crl_table_netslopeScaling.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.
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See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Equal Slope and Zero Net Bias Code Replacement” on page 68-158

 Net Slope Scaling Code Replacement

68-157



Equal Slope and Zero Net Bias Code Replacement
You can define code replacement entries for addition or subtraction of fixed-point data types such
that they match the relative slope and bias values (equal slope and zero net bias) across operator
inputs and output. These entries allow you to disregard slope and bias values when mapping relative
slope and bias values to a replacement function for addition or subtraction.

This example shows how to develop a code replacement library to optimize the performance of fixed
point net slope operations by providing information on how to define code replacement for an
addition operation. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_equal_slope_netbias_add. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Fixed Point Net
Slope Operation.

4 Create entry parameters. In the Operation drop-down list, select Addition.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of
fixdt(true,16,*,*) and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. In the Function arguments subsection of the crtool,
specify the return argument, y1, and the input argument, u1 and u2 with the Data Type of int
16.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
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10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntryGenerator_NetSlope.

function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.

function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                     'RTW_OP_ADD', ...
    'Priority',                 90, ...
    'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
    'SlopesMustBeTheSame',      true, ...
    'MustHaveZeroNetBias',      true, ...
    'ImplementationName',       'u16_add_SameSlopeZeroBias', ...
    'ImplementationHeaderFile', 'u16_add_SameSlopeZeroBias.h', ...
    'ImplementationSourceFile', 'u16_add_SameSlopeZeroBias.c');
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5 Create conceptual arguments y1, u1, and u2. This example uses calls to the
createAndAddConceptualArg function to create and add an argument with one function call.
Specify each argument as fixed-point, 16 bits, and signed. Also, for each argument, specify that
code replacement request processing does not check for an exact match to the call-site slope and
bias values.
function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                     'RTW_OP_ADD', ...
    'Priority',                 90, ...
    'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
    'SlopesMustBeTheSame',      true, ...
    'MustHaveZeroNetBias',      true, ...
    'ImplementationName',       'u16_add_SameSlopeZeroBias', ...
    'ImplementationHeaderFile', 'u16_add_SameSlopeZeroBias.h', ...
    'ImplementationSourceFile', 'u16_add_SameSlopeZeroBias.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'y1', ...
    'IOType',         'RTW_IO_OUTPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u1', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u2', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. This example uses calls to the
createAndSetCImplementationReturn function to create and add implementation
arguments to the entry. Implementation arguments must describe fundamental numeric data
types (not fixed-point data types). In this case, the output and input arguments are 16 bits and
signed (int16).
function hTable = crl_table_equal_slope_netbias_add
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntryGenerator_NetSlope;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                     'RTW_OP_ADD', ...
    'Priority',                 90, ...
    'SaturationMode',           'RTW_WRAP_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_UNSPECIFIED'}, ...
    'SlopesMustBeTheSame',      true, ...
    'MustHaveZeroNetBias',      true, ...
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    'ImplementationName',       'u16_add_SameSlopeZeroBias', ...
    'ImplementationHeaderFile', 'u16_add_SameSlopeZeroBias.h', ...
    'ImplementationSourceFile', 'u16_add_SameSlopeZeroBias.c');

%% Create the conceptual representation
createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'y1', ...
    'IOType',         'RTW_IO_OUTPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u1', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

createAndAddConceptualArg(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'u2', ...
    'IOType',         'RTW_IO_INPUT', ...
    'CheckSlope',     false, ...
    'CheckBias',      false, ...
    'IsSigned',       false, ...
    'WordLength',     16);

%% Create the Implementation Representation
createAndSetCImplementationReturn(hEntry, 'RTW.TflArgNumeric', ...
    'Name',           'y1', ...
    'IOType',         'RTW_IO_OUTPUT', ...
    'IsSigned',       false, ...
    'WordLength',     16, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
    'Name',           'u1', ...
    'IOType',         'RTW_IO_INPUT', ...
    'IsSigned',       false, ...
    'WordLength',     16, ...
    'FractionLength', 0);

createAndAddImplementationArg(hEntry, 'RTW.TflArgNumeric',...
    'Name',           'u2', ...
    'IOType',         'RTW_IO_INPUT', ...
    'IsSigned',       false, ...
    'WordLength',     16, ...
    'FractionLength', 0);

%% Add the entry to the table
addEntry(hTable, hEntry); 

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_equal_slope_netbias_add
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for equal slope and zero net bias code replacement’;

68 Code Replacement Customization for MATLAB Code

68-162



this(1).TableList = {'crl_table_equal_slope_netbias_add.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Net Slope Scaling Code Replacement” on page 68-151
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Data Type Conversions (Casts) and Operator Code
Replacement

You can use code replacement entries to replace code that the code generator produces for data type
conversion (cast) operations. To develop a code replacement library use either the interactive or
programmatic approach. For more information, see “Develop a Code Replacement Library” on page
68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), at the MATLAB command line, enter:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_cast_int32_to_int16. Click Apply.

3 Create entry parameters. In the Operation drop-down list, select Cast.
4 Create an entry. From the crtool context menu, select File > New entry > Fixed Point Net

Slope Operation.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1 with the Data Type of int16 , and the input argument, u1 with
the Data Type of int32 and the Argument Type of Scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box. In the Function
arguments subsection of the crtool, specify the return argument, y1, and the input argument,
u1 with the Data Type of int16 and int32.

Specify a Name for the replacement function under Function prototype.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. In the Mapping Information tab, click Validate entry. In the crtool
context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programmatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function to call your code replacement library table. The function should not have
arguments and return a table object.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_cast_int32_to_int16()
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;
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%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this examples replaces a function, create entry parameters by
calling the function setTflCOperationEntryParameters.The parameters specify the type of
operation as cast, the saturation mode as saturate on integer overflow, rounding modes as
toward negative infinity, and the name of the replacement function as my_sat_cast.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                      'RTW_OP_CAST', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_sat_cast', ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                      'RTW_OP_CAST', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_sat_cast', ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual representation

arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To specify that the implementation arguments have the
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same order and properties as the conceptual arguments, call the function
getTflArgFromString. Add the complete entry to the table by calling the function addEntry.

function hTable = crl_table_cast_int32_to_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
hEntry.setTflCOperationEntryParameters(...
    'Key',                      'RTW_OP_CAST', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_sat_cast', ...
    'SaturationMode',           'RTW_SATURATE_ON_OVERFLOW', ...
    'RoundingModes',            {'RTW_ROUND_FLOOR'}, ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual and implementation representation

arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', 'int32');
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

%% Add the entry to the table
addEntry(hTable,hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_cast_int32_to_int16
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file with these specifications:
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for data type conversions(casts) abd operator code replacement’;
this(1).TableList = {'crl_table_cast_int32_to_int16.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end
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To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Net Slope Scaling Code Replacement” on page 68-151
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Shift Left Operations and Code Replacement
This example shows how to develop a code replacement library to optimize the performance of shift
left (<<) operation by providing information on how to define code replacement for a shift left
function. To develop a code replacement library use either the interactive or programmatic approach.
For more information, see “Develop a Code Replacement Library” on page 68-13.

Interactively Develop a Code Replacement Library
1 Open the Code Replacement Tool (crtool), from the MATLAB command line with the following

command:

>>crtool
2 Create a table.

a From the crtool context menu, select File > New Table.
b In the right pane, name the table crl_table_shift_left_int16. Click Apply.

3 Create an entry. From the crtool context menu, select File > New entry > Math Operation.
4 Create entry parameters. In the Operator drop-down list, select Shift Left.
5 Create the conceptual representation. The conceptual representation describes the signature of

the function that you want to replace. In the Conceptual function subsection of the crtool,
specify the return argument, y1, and the input arguments, u1, and u2, with Data Type of int16
and the Argument Type of scalar.

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. For this example, to specify that the implementation
arguments have the same order and properties as the conceptual arguments, select the Make
conceptual and implementation argument types the same check box.

Under Function prototypespecify a Name for the replacement function.
7 Specify build information. Click the Build Information tab to open the build requirements pane.

Specify the files (source, header, object) that the code generator requires for code replacement.
For this example, you do not need to specify build information.

8 Validate and save the table. Click the Mapping Information tab and verify the fields are filled in
as shown. Click Validate entry. In the crtool context menu, select File > Save table > Save.
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9 Register a code replacement library. Registration creates a library composed of the tables that
you specify. Select File > Generate registration file. In the Generate registration file dialog
box, fill out these fields:

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
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10 Verify the code replacement library. From the MATLAB command line, open the library by using
the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

Programatically Develop a Code Replacement Library
1 Open the programmatic interface from the MATLAB menu by selecting New > Function.
2 Create a table.

a Create a function with the name of your code replacement library table that does not have
arguments and returns a table object. You can use this function to call your code
replacement library table.

b Create a table object by calling RTW.TflTable.

function hTable = crl_table_shift_left_int16
% Create a function to call the code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

3 Create an entry. Because this example replaces a function, create a code replacement entry in
your table by calling the entry function RTW.TflCOperationEntry.

function hTable = crl_table_shift_left_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry
hEntry = RTW.TflCOperationEntry;

4 Create entry parameters. Because this example replaces a function, create entry parameters by
calling the function setTflCFunctionEntryParameters.

function hTable = crl_table_shift_left_int16()
% Create a code replacement library table 

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_SL', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_shift_left', ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

5 Create the conceptual representation. The conceptual representation describes the signature of
the function that you want to replace. To explicitly specify argument properties, call the function
getTflArgFromString and addConceptualArg .
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function hTable = crl_table_shift_left_int16()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_SL', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_shift_left', ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual representation
arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', 'int16');
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', 'int16');
arg.CheckType = false;
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

6 Create the implementation representation. The implementation representation describes the
signature of the optimization function. To explicitly specify argument properties, call the function
getTflArgFromString.

function hTable = crl_table_shift_left_int16()
% Create a code replacement library table

%% Create a table object
hTable = RTW.TflTable;

%% Create an entry 
hEntry = RTW.TflCOperationEntry;

%% Create entry parameters
setTflCOperationEntryParameters(hEntry, ...
    'Key',                      'RTW_OP_SL', ...
    'Priority',                 50, ...
    'ImplementationName',       'my_shift_left', ...
    'ImplementationHeaderFile', 'some_hdr.h', ...
    'ImplementationSourceFile', 'some_hdr.c');

%% Create the conceptual and implementation representation
arg = getTflArgFromString(hTable, 'y1', 'int16');
arg.IOType = 'RTW_IO_OUTPUT';
addConceptualArg(hEntry, arg);
hEntry.Implementation.setReturn(arg);

arg = getTflArgFromString(hTable, 'u1', 'int16');
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);

arg = getTflArgFromString(hTable, 'u2', 'int16');
arg.CheckType = false;
addConceptualArg(hEntry, arg);
hEntry.Implementation.addArgument(arg);
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%% Add the entry to the table
hTable.addEntry(hEntry);

7 Specify build information. In the entry parameters, specify files (header, source, object) that the
code generator needs for code replacement. For this example, build information is not required.

8 Validate and save the customization file. From the MATLAB menu, save this customization file by
selecting File > Save. From the command line, validate the code replacement library table by
calling it:

>> hTable = crl_table_shift_left_int16
9 Register the code replacement library. Registration creates a code replacement library by

defining the library name, code replacement tables, and other information. Create a registration
file (a new function file) by using these specifications.
function rtwTargetInfo(cm)
 
cm.registerTargetInfo(@loc_register_crl);
end
 
function this = loc_register_crl 
 
this(1) = RTW.TflRegistry; 
this(1).Name = 'CRL for shift left operation’;
this(1).TableList = {'crl_table_shift_left_int16.m'}; % table created in this example
this(1).TargetHWDeviceType = {'*'};
this(1).Description = 'Example code replacement library';

end

To use your code replacement library, refresh your current MATLAB session with the command:

>>sl_refresh_customizations
10 Verify the code replacement library. From the MATLAB command line, open the library by using

the Code Replacement Viewer and verify that the table and entry are correctly specified. For
more information, see “Verify Code Replacement Library” on page 67-55. Configure your model
to use the code replacement library, generate code, and verify that replacement occurs as
expected. If unexpected behavior occurs, examine the hit and miss logs to troubleshoot the
issues.

See Also

More About
• “Code You Can Replace from MATLAB Code” on page 68-5
• “Define Code Replacement Library Optimizations” on page 68-23
• “Develop a Code Replacement Library” on page 68-13
• “Net Slope Scaling Code Replacement” on page 68-151
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Optimize Generated Code By Developing and Using Code
Replacement Libraries - MATLAB®

Develop and use code replacement libraries to replace function and operators in generated code.
Code replacement is a technique to change the code that the code generator produces for functions
and operators to meet application code requirements. For example, you can replace generated code
to meet requirements such as:

• Optimization for a specific run-time environment, including, but not limited to, specific target
hardware

• Integration with existing application code
• Compliance with a standard, such as AUTOSAR
• Modification of code behavior, such as enabling or disabling nonfinite or inline support
• Application- or project-specific code requirements, such as use of BLAS or elimination of math.h,

system header files, or calls to memcpy or memset.

You can configure the code generator to use a code replacement library that MathWorks® provides.
If you have an Embedded Coder® license, you can develop your own code replacement library
interactively with the Code Replacement Tool or programmatically.

This example provides MATLAB® code that shows a variety of ways you can define code replacement
mappings. With each example MATLAB® function, the example provides MATLAB® files that
illustrate how to develop function and operator code replacements programmatically.

Additional Requirements:

• MATLAB Coder
• Embedded Coder
• Fixed-Point Designer

For more information, see “What Is Code Replacement Customization?” on page 68-3 and “Develop a
Code Replacement Library” on page 68-13.

Create a New Folder and Copy Relevant Files

The following code creates a sub folder in your current working folder (pwd). The new folder contains
files that are relevant for this example.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
coderdemo_setup('coderdemo_crl');

Steps for Developing a Code Replacement Library

1 Identify your code replacement requirements with respect to function or operating mappings,
build information, and registration information.

2 Prepare for code replacement library development (for example, identify or develop models to
test your library).

3 Define code replacement mappings.
4 Specify build information for replacement code.
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5 Register code replacement mappings.
6 Verify code replacements.
7 Deploy the library.

For more information, see “Develop a Code Replacement Library” on page 68-13.

Math Function Replacement

This example defines and registers code replacement mappings for math functions. You can define
code replacement mappings for a variety of functions. For details, see “Code You Can Replace from
MATLAB Code” on page 68-5.

1. Open and explore the MATLAB® file for this example.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','replace_math_fcns.m'))

2. Configure the code generator to use the code replacement library Function Replacement
Examples.

RTW.TargetRegistry.getInstance('reset');
cfg = coder.config('lib','ecoder',true);
cfg.CodeReplacementLibrary = 'Function Replacement Examples';
cfg.GenerateReport = false;
cfg.LaunchReport = false;

3. Set up the configuration parameters to build and define the function input type.

t = single(2); 

4. Explore the code replacement table definition file.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','crl_table_functions.m'))

5. Compile the MATLAB® program into a C source file by using the configuration parameters that
point to the code replacement library and the example input class defined in step 3 as input
parameters to the codegen command.

codegen('replace_math_fcns', '-config', cfg, '-args', {t, t});

Code generation successful.

6. Open the file replace_math_fcns.c and explore the generated source code.

open(fullfile('codegen','lib','replace_math_fcns','replace_math_fcns.c'))

7. Close replace_math_fcns.m.

For more information on math function replacement, see “Math Function Code Replacement” on page
68-51.

Addition and Subtraction Operator Replacement

This example shows how to define and register code replacement mappings for addition (+) and
subtraction (-) operations. When defining entries for addition and subtraction operations, you can
specify which of the following algorithms (EntryInfoAlgorithm) your library functions implement:
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• Cast-before-operation (CBO) (RTW_CAST_BEFORE_OP), the default
• Cast-after-operation (CAO) (RTW_CAST_AFTER_OP)

1. Open and explore the MATLAB® file for this example.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','addsub_two_int16.m'))
%
% CBO, the default algorithm, is assumed.

2. Configure the code generator to use a code replacement library Addition & Subtraction
Examples.

RTW.TargetRegistry.getInstance('reset');
cfg = coder.config('lib','ecoder',true);
cfg.CodeReplacementLibrary = 'Addition & Subtraction Examples';
cfg.GenerateReport = false;
cfg.LaunchReport = false;

3. Set up the configuration parameters to build and define the operation input type.

t = int16(2); 

4. Explore the code replacement table definition file.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','crl_table_addsub.m'))

5. Compile the MATLAB® program into a C source file by using the configuration parameters that
point to the desired code replacement library and the example input class defined in step 3 as input
parameters to the codegen command.

codegen('addsub_two_int16','-config', cfg, '-args', {t, t});

Code generation successful.

6. Open the file addsub_two_int16.c and explore the generated source code.

open(fullfile('codegen','lib','addsub_two_int16','addsub_two_int16.c'))

7. Close addsub_two_int16.m.

For more information on addition and subtraction operator replacement, see “Scalar Operator Code
Replacement” on page 68-99 and “Addition and Subtraction Operator Code Replacement” on page 68-
104.

Matrix Operator Replacement

This example defines and registers code replacement mappings for matrix operations: addition,
subtraction, multiplication, transposition, conjugate, and Hermitian.

Supported types include:

• single, double
• int8, uint8
• int16, uint16
• int32, uint32
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• csingle, cdouble
• cint8, cuint8
• cint16, cuint16
• cint32, cuint32
• fixed-point integers
• mixed types (different type on each input)

1. Open and explore the MATLAB® file for this example:

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','replace_matrix_ops.m'))

2. Configure the code generator to use a code replacement library Matrix Op Replacement
Examples.

RTW.TargetRegistry.getInstance('reset');
cfg = coder.config('lib','ecoder',true);
cfg.CodeReplacementLibrary = 'Matrix Op Replacement Examples';
cfg.GenerateReport = false;
cfg.LaunchReport = false;

3. Set up the configuration parameters to build and define the operation input type.

t = [1.0 2.0; 3.0, 4.0]; 

4. Explore the code replacement table definition file.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','crl_table_matops.m'))

5. Compile the MATLAB® program using the configuration parameters that point to the desired code
replacement library and the example input class defined in step 3 as input parameters to the
codegen command.

codegen('replace_matrix_ops', '-config', cfg, '-args', {t, t});

Code generation successful.

6. Open the file replace_matrix_ops.c and explore the generated source code.

open(fullfile('codegen','lib','replace_matrix_ops','replace_matrix_ops.c'))

7. Close replace_matrix_ops.m.

For more information on matrix operator replacement, see “Small Matrix Operation to Processor
Code Replacement” on page 68-111.

Matrix Multiplication Replacement for BLAS

This example defines and registers code replacement mappings for Basic Linear Algebra Subroutines
(BLAS) subroutines xGEMM and xGEMV. You can map the following operations to a BLAS subroutine:

• Matrix multiplication
• Matrix multiplication with transpose on single or both inputs
• Matrix multiplication with Hermitian operation on single or both inputs

1. Open and explore the MATLAB® file for this example.
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edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','replace_matrix_ops_blas.m'))

2. Configure the code generator to use a code replacement library BLAS Replacement Examples.

RTW.TargetRegistry.getInstance('reset');
cfg = coder.config('lib','ecoder',true);
cfg.CodeReplacementLibrary = 'BLAS Replacement Examples';
cfg.GenerateReport = false;
cfg.LaunchReport = false;

3. Set up the configuration parameters to build and define the function input type.

t = [1.0 2.0 3.0; 4.0 5.0 6.0; 7.0 8.0 9.0]; 

4. Explore the code replacement table definition file.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','crl_table_blas.m'))

5. Compile the MATLAB® program using the configuration parameters that point to the desired code
replacement library and the example input class defined in step 3 as input parameters to the
codegen command.

codegen('replace_matrix_ops_blas', '-config', cfg, '-args', {t, t});

Code generation successful.

6. Open the file replace_matrix_ops_blas.c and explore the generated source code.

open(fullfile('codegen','lib','replace_matrix_ops_blas','replace_matrix_ops_blas.c'))

7. Close replace_matrix_ops_blas.m.

For more information on matrix multiplication replacement for BLAS, see “Matrix Multiplication
Operation to MathWorks BLAS Code Replacement” on page 68-117.

MATLAB Function Replacement Using Coder.Replace

Code replacement libraries support the replacement of MATLAB® functions with scalar and matrix
inputs and outputs for built-in, complex, and fixed-point data types.

1. Open and explore the MATLAB® file for this example.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','coder_replace_fcn.m'))

2. Configure the code generator to use a code replacement library Coder Replace Examples.

RTW.TargetRegistry.getInstance('reset');
cfg = coder.config('lib','ecoder',true);
cfg.CodeReplacementLibrary = 'Coder Replace Examples';
cfg.GenerateReport = false;
cfg.LaunchReport = false;

3. Set up the configuration parameters to build and define the function input type.

t = [1 2; 3 4];

4. Explore the code replacement table definition file.

edit(fullfile(matlabroot,'toolbox','coder','codegendemos','coderdemo_crl','crl_table_coder_replace.m'))
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5. Compile the MATLAB® program using the configuration parameters that point to the desired code
replacement library and the example input class defined in step 3 as input parameters to the
codegen command.

codegen('coder_replace_fcn', '-config', cfg, '-args', {t, t});

Code generation successful.

6. Open the file coder_replace_fcn.c and explore the generated source code.

open(fullfile('codegen','lib','coder_replace_fcn','coder_replace_fcn.c'))

7. Close coder_replace_fcn.m.

For more information, see docid:ecoder_ug.mw_ab7cd3a5-076f-40e4-b8a9-d3357993c100.

Build Information

For each entry in a code replacement table, you can specify build information such as the following,
for replacement functions:

• Header file dependencies
• Source file dependencies
• Additional include paths
• Additional source paths
• Additional link flags

Additionally, you can specify RTW.copyFileToBuildDir to copy header, source, or object files,
which are required to generate replacement code, to the build folder before code generation. You can
specify RTW.copyFileToBuildDir by setting it as the value of:

• Property GenCallback in a call to setTflCFunctionEntryParameters,
setTflCOperationEntryParameters, or setTflCSemaphoreEntryParameters.

• Argument genCallback in a call to registerCFunctionEntry, registerCOperationEntry,
or registerCSemaphoreEntry.

Note: Models in this example are configured for code generation only because the implementations
for the replacement functions are not provided.

For more information on specifying build information for replacement code, see “Develop a Code
Replacement Library” on page 68-13.

Cleanup

Remove files and return to original folder

RTW.TargetRegistry.getInstance('reset');
rtwdemoclean;
clear coderdemo_crl
cd ../
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Optimizations for Generated Code in
Simulink Coder

• “Increase Code Generation Speed” on page 69-3
• “Control Compiler Optimizations” on page 69-6
• “Optimization Tools and Techniques” on page 69-7
• “Control Memory Allocation for Time Counters” on page 69-10
• “Execution Profiling for Generated Code” on page 69-11
• “Optimize Generated Code by Combining Multiple for Constructs” on page 69-13
• “Subnormal Number Execution Speed” on page 69-16
• “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values”

on page 69-20
• “Remove Code That Maps NaN to Integer Zero” on page 69-23
• “Disable Nonfinite Checks or Inlining for Math Functions” on page 69-26
• “Fold Expressions” on page 69-31
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
• “Inline Invariant Signals” on page 69-38
• “Inline Numeric Values of Block Parameters” on page 69-41
• “Configure Loop Unrolling Threshold” on page 69-46
• “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 69-48
• “Generate Target Optimizations Within Algorithm Code” on page 69-51
• “Remove Code for Blocks That Have No Effect on Computational Results” on page 69-52
• “Eliminate Dead Code Paths in Generated Code” on page 69-55
• “Floating-Point Multiplication to Handle a Net Slope Correction” on page 69-58
• “Use Conditional Input Branch Execution” on page 69-61
• “Optimize Generated Code for Complex Signals” on page 69-65
• “Speed Up Linear Algebra in Code Generated from a MATLAB Function Block” on page 69-67
• “Speed Up Matrix Operations in Code Generated from a MATLAB Function Block” on page 69-70
• “Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block”

on page 69-74
• “Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block”

on page 69-77
• “Control Memory Allocation for Variable-Size Arrays in a MATLAB Function Block” on page 69-81
• “Optimize Memory Usage for Time Counters” on page 69-83
• “Optimize Generated Code Using Boolean Data for Logical Signals” on page 69-88
• “Reduce Memory Usage for Boolean and State Configuration Variables” on page 69-91
• “Customize Stack Space Allocation” on page 69-92
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• “Optimize Generated Code Using memset Function” on page 69-93
• “Vector Operation Optimization” on page 69-97
• “Enable and Reuse Local Block Outputs in Generated Code” on page 69-100
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Increase Code Generation Speed
In this section...
“Build a Model in Increments” on page 69-3
“Build Large Model Reference Hierarchies in Parallel” on page 69-3
“Minimize Memory Requirements During Code Generation” on page 69-4
“Generate Only Code” on page 69-4
“Suppress Creation of a Code Generation Report” on page 69-4

The amount of time it takes to generate code for a model depends on the size and configuration
settings of the model. For instance, if you are working with a large model, it can take awhile to
generate code. To decrease the amount of time for code generation of a model, try one or more of the
following methods:

• Build a model in increments
• Build large model reference hierarchies in parallel
• Minimize memory requirements during code generation
• Generate only code
• Disable the creation of a code generation report

Build a Model in Increments
You can use the slbuild command to build a model and generate code. By default, when rebuilding
a model, slbuild provides an incremental model build, which only rebuilds a model or submodels
that have changed since the most recent model build. Incremental model build saves code generation
time. Use the Rebuild parameter on the Model Referencing pane to change the method that
Simulink uses to determine when to rebuild code for referenced models. For more information on the
Rebuild parameter, see “Rebuild”.

Build Large Model Reference Hierarchies in Parallel
In a parallel computing environment, whenever conditions allow, you can increase the speed of code
generation and compilation by building models containing large model reference hierarchies in
parallel. For example, if you have Parallel Computing Toolbox software, you can distribute code
generation and compilation for each referenced model across the cores of a multicore host computer.
If you have MATLAB Parallel Server software, you can distribute code generation and compilation for
each referenced model across remote workers in your MATLAB Parallel Server configuration.

The execution speed improvement realized by using parallel builds for referenced models depends on
several factors, including:

• How many models can be built in parallel for a given model referencing hierarchy
• The size of the referenced models
• Parallel computing resources such as the number of local and remote workers available
• The hardware attributes of the local and remote machines (amount of RAM, number of cores, and

so on)

For more information, see “Reduce Build Time for Referenced Models by Using Parallel Builds”.
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Minimize Memory Requirements During Code Generation
Models that have large amounts of parameter and constant data (such as lookup tables) can tax
memory resources and slow code generation. The code generator copies this data to the model.rtw
file. The model.rtw file is a partial representation of the model that the Target Language Compiler
parses to transform block computations, parameters, signals, and constant data into a high-level
language (for example, C). The Target Language Compiler (TLC) is an integral part of the code
generator. The code generator copies parameters and data into model.rtw, whether they originate
in the model or come from variables or objects in a workspace.

You can improve code generation speed by specifying the maximum number of elements that data
vectors can have for the code generator to copy this data to model.rtw. When a data vector exceeds
the specified size, the code generator places a reference key in model.rtw. The TLC uses this key to
access the data from Simulink and format it into the generated code. Reference keys result in
maintaining only one copy of large data vectors in memory.

The default value above which the code generator uses reference keys in place of actual data values
is 10 elements. You can verify this value. In the Command Window, type the following command:

get_param(0, 'RTWDataReferencesMinSize')

To set the threshold to a different value, in the Command Window, type the following set_param
function:

set_param(0, 'RTWDataReferencesMinSize', <size>)

Provide an integer value for size that specifies the number of data elements above which the code
generator uses reference keys in place of actual data values.

Generate Only Code
You can increase code generation speed by specifying that the build process generate code and a
makefile, but not invoke the make command. When the code generator invokes the make command,
the build process takes longer because the code generator generates code, compiles code, and
creates an executable file.

On the Code Generation pane in the Model Configuration Parameters dialog box, you can specify
that the build process generate only code by selecting the Generate code only parameter. You can
specify that the code generation process build a makefile by selecting the Configuration
Parameters > Code Generation > Build process > Makefile configuration > Generate
makefile parameter.

Suppress Creation of a Code Generation Report
You can speed up code generation by not generating a code generation report as a part of the build
process. To disable the creation of a code generation report, on the Code Generation > Report
pane, clear the Create code generation report parameter. After the build process, you can
generate a code generation report by doing this procedure, “Generate Code Generation Report After
Build Process”.
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See Also

Related Examples
• “Enable parallel model reference builds”
• “MATLAB worker initialization for builds”
• “Reduce Build Time for Referenced Models by Using Parallel Builds” on page 57-36
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Control Compiler Optimizations
To control compiler optimizations for a makefile build at the GUI level, use the Compiler
optimization level parameter. The Compiler optimization level parameter provides

• Target-independent values Optimizations on (faster runs) and Optimizations off
(faster builds), which allow you to easily toggle compiler optimizations on and off during
code development

• The value Custom for entering custom compiler optimization flags at the Simulink GUI level,
rather than editing compiler flags into template makefiles (TMFs) or supplying compiler flags to
build process make commands

The default setting is Optimizations off (faster builds). Selecting the value Custom
enables the Custom compiler optimization flags field, in which you can enter custom compiler
optimization flags (for example, -O2).

If you specify compiler options for your makefile build using OPT_OPTS, MEX_OPTS (except
MEX_OPTS="-v"), or MEX_OPT_FILE, the value of Compiler optimization level is ignored and a
warning is issued about the ignored parameter.

For a rapid simulation that uses the MinGW® compiler:

• If RTWCompilerOptimization is set to 'on', the build process customizes compiler
optimization to minimize run time. The build process ignores the BuildConfiguration and
CustomToolchainOptions settings.

• If RTWCompilerOptimization is set to 'custom' or 'off', the build process uses
BuildConfiguration and CustomToolchainOptions settings. The build process ignores the
RTWCompilerOptimization setting.

See Also

Related Examples
• “Template Makefiles and Make Options” on page 57-21
• “Configure a System Target File” on page 48-2
• “Support Compiler Optimization Level Control” on page 86-65
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Optimization Tools and Techniques
Use the Model Advisor to Optimize a Model for Code Generation
You can use the Model Advisor to analyze a model for code generation and identify aspects of your
model that impede production deployment or limit code efficiency. You can select from a set of checks
to run on a model's current configuration. The Model Advisor analyzes the model and generates
check results providing suggestions for improvements in each area. Most Model Advisor diagnostics
do not require the model to be in a compiled state; those that do are noted.

Before running the Model Advisor, select the target you plan to use for code generation. The Model
Advisor works most effectively with ERT and ERT-based system target files.

Use the following examples to investigate optimizing models for code generation using the Model
Advisor:

• rtwdemo_advisor1
• rtwdemo_advisor2
• rtwdemo_advisor3

Note Example models rtwdemo_advisor2 and rtwdemo_advisor3 require Stateflow and Fixed-
Point Designer software.

For more information on using the Model Advisor, see “Run Model Advisor Checks”. For more
information about the checks, see “Simulink Coder Checks”.

Design Tips for Optimizing Generated Code for Stateflow Objects
Do Not Access Machine-Parented Data In a Graphical Function

This restriction prevents long parameter lists from appearing in the code generated for a graphical
function. You can access local data that resides in the same chart as the graphical function. For more
information, see “Reuse Logic Patterns by Defining Graphical Functions” (Stateflow).

Be Explicit About the Inline Option of a Graphical Function

When you use a graphical function in a Stateflow chart, select Inline or Function for the property
Function Inline Option. Otherwise, the code generated for a graphical function may not appear as
you want. For more information, see “Specify Properties of Graphical Functions” (Stateflow).

Avoid Using Multiple Edge-Triggered Events in Stateflow Charts

If you use more than one trigger, you generate multiple code statements to handle rising or falling
edge detections. If multiple triggers are required, use function-call events instead. For more
information, see “Activate a Stateflow Chart by Sending Input Events” (Stateflow).

Combine Input Signals of a Chart Into a Single Bus Object

When you use a bus object, you reduce the number of parameters in the parameter list of a generated
function. This guideline also applies to output signals of a chart. For more information, see “Define
Stateflow Structures” (Stateflow).
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Use Charts with Discrete Sample Times

The code generated for discrete charts that are not inside a triggered or enabled subsystem uses
integer counters to track time instead of Simulink provided time. This allows for more efficient code
generation in terms of overhead and memory, as well as enabling this code for use in software-in-the-
loop (SIL) and processor-in-the-loop (PIL) simulations.

Additional Optimization Techniques
You can apply the following techniques to optimize a model for code generation:

• For Embedded Coder users, if your application uses only integer arithmetic, clear the Support
floating-point numbers parameter in the Software environment section of the Interface pane
so that the generated code does not contain floating-point data or operations. When this
parameter is cleared, an error is raised if noninteger data or expressions are encountered during
code generation. The error message reports the offending blocks and parameters.

• Disable the Configuration Parameters > Code Generation > Interface > Advanced
parameters > MAT-file logging parameter. Deselecting this parameter eliminates extra code
and memory usage for initializing, updating, and cleaning-up logging variables. In addition, the
code generated to support MAT-file logging invokes malloc, which can be undesirable for your
application.

• Use the Upgrade Advisor to upgrade older models (saved by prior versions or the current version)
to use current features. For details, see “Model Upgrades”.

• Before building, set optimization flags for the compiler (for example, -O2 for gcc, -Ot for the
Microsoft Visual C++ compiler).

• Directly inline C/C++ S-functions into the generated code by writing a TLC file for the S-function.
For more information, see “Accelerate Simulation, Reuse Code, or Protect Intellectual Property by
Using S-Function Target” and see “Inline C MEX S-Functions”.

• Use a Simulink data type other than double when possible. The available data types are
Boolean, signed and unsigned 8-, 16-, and 32-bit integers, and 32- and 64-bit floats (a double is
a 64-bit float). For more information, see “About Data Types in Simulink”. For a block-by-block
summary, click showblockdatatypetable or type the command in the Command Window.

• For tunable block parameters that you configure to store in memory in the generated code, you
can match parameter data types with signal data types to eliminate unnecessary typecasts and C
shifts. Where possible, store parameter values in small integer data types. See “Parameter Data
Types in the Generated Code” on page 34-129.

• Remove repeated values in lookup table data.
• Use the Merge block to merge the output of signals wherever possible. This block is particularly

helpful when you need to control the execution of function-call subsystems with a Stateflow chart.
The following model shows an example of how to use the Merge block.
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When more than one signal connected to a Merge block has a non-Auto storage class, all non-
Auto signals connected to that block must be identically labeled and have the same storage class.
When Merge blocks connect directly to one another, these rules apply to the signals connected to
any of the Merge blocks in the group.

See Also

Related Examples
• “Increase Code Generation Speed” on page 69-3
• “Execution Profiling for Generated Code” on page 69-11
• “Model Configuration Parameters: Code Generation Optimization”
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Control Memory Allocation for Time Counters
The Application lifespan (days) parameter lets you control the allocation of memory for absolute
and elapsed time counters. Such counters exist in the code for blocks that use absolute or elapsed
time. For a list of such blocks, see “Absolute Time Limitations”.

The size of the time counters in generated code is 8, 16, 32, or 64 bits. The size is set automatically to
the minimum that can accommodate the duration value specified by Application lifespan (days)
given the step size specified in the Configuration Parameters Solver pane. To minimize the amount of
RAM used by time counters, specify the smallest lifespan possible and the largest step size possible.

An application runs to its specified lifespan. It may be able to run longer. For example, running a
model with a step size of one millisecond (0.001 seconds) for one day requires a 32-bit timer, which
could continue running without overflow for 49 days more.

To maximize application lifespan, specify Application lifespan (days) as inf. This value allocates
64 bits (two uint32 words) for each timer. Using 64 bits to store timing data would allow a model
with a step size of 0.001 microsecond (10E-09 seconds) to run for more than 500 years, which would
rarely be required. 64-bit counters do not violate the usual code generator length limitation of 32 bits
because the value of a time counter does not provide the value of a signal, state, or parameter.

See Also
“Application lifespan (days)”

Related Examples
• “Absolute and Elapsed Time Computation”
• “Timers in Asynchronous Tasks”
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Execution Profiling for Generated Code
Use code execution profiling to:

• Determine whether the generated code meets execution time requirements for real-time
deployment on your target hardware.

• Identify code sections that require execution speed improvements.

The following tasks represent a general workflow that uses code execution profiling:

1 With the Simulink model, design and optimize your algorithm.
2 Configure the model for code execution profiling, and generate code.
3 Execute generated code on target. For example, you can:

• Run a software-in-the-loop (SIL) simulation on your development computer.
• Run a processor-in-the-loop (PIL) simulation using a target support package or custom PIL

target.
• Perform real-time execution with Simulink Real-Time or a target support package.

4 Analyze execution speed through code execution profiling plots and reports. For example, check
that the algorithm code satisfies execution time requirements for real-time deployment:

• If the algorithm code easily meets the requirements, consider enhancing your algorithm to
exploit available processing power.

• If the code cannot be executed in real time, look for ways to reduce execution time.

Identify the tasks that require the most time. For these tasks, investigate whether trade-offs
between functionality and speed are possible.

If your target is a multicore processor, distribute the execution of algorithm code across
available cores.

5 If required, refine the model and return to step 2.

To find information about code execution profiling with Simulink products, use the following table.

Target Execution
Feature

Type of
Profiling

Relevant
Products

See

Development
computer

Model configured
for concurrent
execution

Execution
time

Simulink Coder • “Optimize and Deploy on a
Multicore Target”

Development
computer

Software-in-the-
loop (SIL)

Execution
time

Embedded Coder • “Code Execution Profiling with
SIL and PIL” on page 74-2

• “View and Compare Code
Execution Times” on page 74-6

• “Analyze Code Execution Data”
on page 74-15
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Target Execution
Feature

Type of
Profiling

Relevant
Products

See

Embedded
hardware or
instruction set
simulator

Processor-in-the-
loop (PIL)

Execution
time

Embedded Coder • “Code Execution Profiling with
SIL and PIL” on page 74-2

• “View and Compare Code
Execution Times” on page 74-6

• “Analyze Code Execution Data”
on page 74-15

Simulink Real-
Time

Real-time
execution

Execution
time

Simulink Coder,
Simulink Real-
Time

• “Execution Profiling for Real-
Time Applications” (Simulink
Real-Time)

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “SIL and PIL Simulations” on page 80-2
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Optimize Generated Code by Combining Multiple for
Constructs

This example shows how the code generator combines for loops. The generated code uses for
constructs to represent a variety of modeling patterns, such as a matrix signal or Iterator blocks.
Using data dependency analysis, the code generator combines for constructs to reduce static code
size and runtime branching.

The benefits of optimizing for loops are:

• Reducing ROM and RAM consumption.
• Increasing execution speed.

for Loop Modeling Patterns

In the model, rtwdemo_forloop, the Switch block and MATLAB Function block represent for
constructs. In the In1 Block Parameters dialog box, the Port dimensions parameter is set to 10 .

Generate Code

The model does not contain data dependencies across the for loop iterations. Therefore, the code
generator combines for loops into one loop. Open the Simulink Coder or Embedded Coder app.
Then, generate and view the code.

### Starting build procedure for: rtwdemo_forloop
### Successful completion of build procedure for: rtwdemo_forloop
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matlab:rtwdemo_forloop


Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                                    
================================================================================================
rtwdemo_forloop  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.034s

The generated file, rtwdemo_forloop.c, contains the code for the single for loop.

/* Model step function */
void rtwdemo_forloop_step(void)
{
  int32_T k;

  /* MATLAB Function: '<Root>/Accum' */
  /* MATLAB Function 'Accum': '<S1>:1' */
  /* '<S1>:1:3' */
  /* '<S1>:1:4' */
  rtwdemo_forloop_Y.Out1 = 0.0;

  /* '<S1>:1:5' */
  for (k = 0; k < 10; k++) {
    /* Switch: '<Root>/Switch' incorporates:
     *  Gain: '<Root>/G1'
     *  Gain: '<Root>/G3'
     *  Inport: '<Root>/In1'
     *  Sum: '<Root>/Sum1'
     *  Sum: '<Root>/Sum2'
     *  UnitDelay: '<Root>/Delay'
     */
    if (3.0 * rtwdemo_forloop_U.In1[k] >= 0.0) {
      rtwdemo_forloop_DW.Delay_DSTATE[k] = rtwdemo_forloop_U.In1[k] -
        rtwdemo_forloop_DW.Delay_DSTATE[k];
    } else {
      rtwdemo_forloop_DW.Delay_DSTATE[k] = (rtwdemo_forloop_DW.Delay_DSTATE[k] -
        rtwdemo_forloop_U.In1[k]) * 5.0;
    }

    /* End of Switch: '<Root>/Switch' */

    /* MATLAB Function: '<Root>/Accum' */
    /* '<S1>:1:5' */
    /* '<S1>:1:6' */
    rtwdemo_forloop_Y.Out1 += ((real_T)k + 1.0) +
      rtwdemo_forloop_DW.Delay_DSTATE[k];
  }
}
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Close the model.

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Configure Loop Unrolling Threshold” on page 69-46
• “For Loop” on page 25-31
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Subnormal Number Execution Speed
Subnormal numbers, formerly known as denormal numbers in floating-point literature, fill the
underflow gap around zero in floating-point arithmetic. Subnormal values are a special category of
floating-point values that are too close to 0.0 to be represented as a normalized value. The leading
significand (mantissa) of a subnormal number is zero. When adding and subtracting floating-point
numbers, subnormal numbers prevent underflow.

Using subnormal numbers provides precision beyond the normal representation by using leading
zeros in the significand to represent smaller values after the representation reaches the minimum
exponent. As the value approaches 0.0, you trade off precision for extended range. Subnormal
numbers are useful if your application requires extra range.

However, in a real-time system, using subnormal numbers can dramatically increase execution
latency, resulting in excessive design margins and real-time overruns. If the simulation or generated
code performs calculations that produce or consume subnormal numbers, the execution of these
calculations can be up to 50 times slower than similar calculations on normal numbers. The actual
simulation or code execution time for subnormal number calculations depends on your computer
operating environment. Typically, for desktop processors, the execution time for subnormal number
calculations is five times slower than similar calculations on normal numbers.

To minimize the possibility of execution slowdowns or overruns due to subnormal number calculation
latency, do one of the following:

• In your model, manually flush to zero any incoming or computed subnormal values at inputs and
key operations, such as washouts and filters. For an example, see “Flush Subnormal Numbers to
Zero” on page 69-17.

To detect a subnormal value for a single precision, 32-bit floating-point number:

1 Find the smallest normalized number on a MATLAB host. In the Command Window, type:

>> SmallestNormalSingle = realmin('single')

In the C language, FLT_MIN , defined in float.h, is equivalent to realmin('single').
2 Look for values in range:

 0 < fabsf(x) < SmallestNormalSingle 

To detect a subnormal value for a double precision, 64-bit floating-point number:

1 Find the smallest normalized number on a MATLAB host. In the Command Window, type:

>> SmallestNormalDouble = realmin('double') 

In the C language, DBL_MIN , defined in float.h, is equivalent to realmin('double').
2 To detect a subnormal value, look for values in this range:

0 < fabs(x) < SmallestNormalDouble
• Set the Simulation behavior for denormal numbers parameter to Flush to zero (FTZ) to

emulate flush-to-zero behavior for all denormal results from arithmetic operations. For more
information, see “Simulation behavior for denormal numbers”.

• On your processor, set flush-to-zero mode or, with your compiler, specify an option to disable
subnormal numbers. Flush-to-zero modes treat a subnormal number as 0 when it is an input to a
floating-point operation. Underflow exceptions do not occur in flush-to-zero mode.
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For example, in Intel® processors, the flush-to-zero (FTZ) and denormals-are-zero (DAZ) flags in
the MXCSR register control floating-point calculations. For the gcc compiler on Linux, -ffast-
math sets abrupt underflow (FTZ), flush-to-zero, while –O3 -ffast-math reverts to gradual
underflow, using subnormal numbers.

For more information, see the IEEE Standard 754, IEEE Standard for Floating-Point Arithmetic.

Simulation Time With and Without Subnormal Numbers
This model shows how using subnormal numbers increases simulation time by ~5 times.

Open the model ex_subnormal. The Gain is set to subnormal value realmin('double')/2.

To run a simulation, in the Command Window, type for k=1:5, tic; sim('ex_subnormal');
toc,end. Observe the elapsed times for simulation using subnormals, similar to the following:

>> for k=1:5, tic; sim('ex_subnormal'); toc,end
Elapsed time is 9.909326 seconds.
Elapsed time is 9.617966 seconds.
Elapsed time is 9.797183 seconds.
Elapsed time is 9.702397 seconds.
Elapsed time is 9.893946 seconds.

Set the Gain to a number, 2, that is not a subnormal value:

>> set_param('ex_subnormal/Gain', 'Gain', '2');

To run a simulation, in the Command Window, type for k=1:5, tic; sim('ex_subnormal');
toc,end. Observe elapsed times for simulations that do not use subnormal values, similar to the
following:

>> for k=1:5, tic; sim('ex_subnormal'); toc,end
Elapsed time is 2.045123 seconds.
Elapsed time is 1.796598 seconds.
Elapsed time is 1.758458 seconds.
Elapsed time is 1.721721 seconds.
Elapsed time is 1.780569 seconds.

Flush Subnormal Numbers to Zero
This example shows how to flush single precision subnormal numbers to zero.

1 Open the model ex_flush_to_zero:
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• Repeating Sequence Stair generates a sequence of numbers from two raised to the
power of 0 through two raised to the power of -165. The sequence approaches zero.

• ConditionRealScalar flushes subnormal single precision values that are less than
realmin('single') to zero.

• MATLAB function block log2 generates the base 2 logarithm of the Repeating Sequence
Stair output. Specifically, log2 generates the numbers 0 through -165.

2 On the Simulation > Step Back > Configure simulation stepping pane:

• Select Enable stepping back.
• Select Pause simulation when time reaches and enter 121.

3 In the model window, run the simulation. The simulation pauses at T=121. The displayed values:

• ConditionRealScalar output approaches zero.
• Repeating Sequence Stair output approaches zero.

4 Step the simulation forward to T=127. ConditionRealScalar flushes the subnormal value
output from Repeating Sequence Stair to zero.
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5 Continue stepping the simulation forward. ConditionRealScalar flushes the subnormal single
precision values output from Repeating Sequence Stair to zero. When T=150, the output of
Repeating Squence Stair is itself zero.

See Also

Related Examples
• “Data Types Supported by Simulink”
• “Numerical Consistency of Model and Generated Code Simulation Results”
• “Specify Single-Precision Data Type for Embedded Application” on page 34-101
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Remove Code From Floating-Point to Integer Conversions That
Wraps Out-of-Range Values

In this section...
“Example Model” on page 69-20
“Generate Code Without Optimization” on page 69-21
“Generate Code with Optimization” on page 69-21

This example shows how to remove code for out-of-range floating-point to integer conversions.
Without this code, there might be a mismatch between simulation and code generation results.
Standard C does not define the behavior of out-of-range floating-point to integer conversions, while
these conversions are well-defined during simulation. In Standard C and during simulation, floating-
point to integer conversions are well-defined for input values in the range of the output type.

If the input values in your application are in the range of the output type, remove code for out-of-
range floating-point to integer conversions. Removing this code reduces the size and increases the
speed of the generated code.

Example Model
In this model, a Data Type Conversion block converts an input signal from a double to a uint8. A
uint8 can support values from 0 to 255. If the input signal has a value outside of this range, an out-
of-range conversion occurs. In this example, the model is named conversion_ex.

1 Use Inport, Outport, and Data Type Conversion blocks to create the example model.
2 Open the Inport Block Parameters dialog box and select the Signal Attributes tab. For the Data

Type parameter, select double.
3 Open the Data Type Conversion dialog box. For the Output data type parameter, select uint8.
4 Open the Simulink Coder app. If you have an Embedded Coder license, open the Embedded

Coder app.
5 Select Code Interface > Individual Element Code Mappings.
6 On the Code Mappings-C > Inports tab, set the storage class to ImportedExtern.
7 In the Code section of the Property Inspector, assign a name to the Identifier such as Inport.
8 On the Code Mappings-C > Outputs tab, set the storage class to ImportedExtern.
9 In the Code section of the Property Inspector, assign a name to the Identifier such as Outport.
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Generate Code Without Optimization
1 Open the Configuration Parameters dialog box. On the Solver pane, for the Type parameter,

select Fixed-step.
2 On the Code Generation > Report pane, select Create code generation report and Open

report automatically.
3 On the Code Generation pane, select Generate code only, and then, in the model window,

press Ctrl+B. When code generation is complete, an HTML code generation report opens.
4 In the Code Generation report, select the conversion_ex.c file and view the model step

function. The code generator applies the fmod function to handle out-of range-results.

void conversion_ex_step(void)
{
  real_T tmp;

  /* DataTypeConversion: '<Root>/Data Type Conversion' incorporates:
   *  Inport: '<Root>/Input'
   */
  tmp = floor(Inport);
  if (rtIsNaN(tmp) || rtIsInf(tmp)) {
    tmp = 0.0;
  } else {
    tmp = fmod(tmp, 256.0);
  }

  /* Outport: '<Root>/Out1' incorporates:
   *  DataTypeConversion: '<Root>/Data Type Conversion'
   */
  Outport = (uint8_T)(tmp < 0.0 ? (int32_T)(uint8_T)-(int8_T)(uint8_T)-tmp :
                      (int32_T)(uint8_T)tmp);
}

Generate Code with Optimization
1 Open the Configuration Parameters dialog box. On the Optimization pane, select Remove code

from floating-point to integer conversions that wraps out-of-range values. Generate code.
2 In the code generation report, select the conversion_ex.c file and view the model step

function. The generated code does not contain code that protects against out-of-range values.

void conversion_ex_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  DataTypeConversion: '<Root>/Data Type Conversion'
   *  Inport: '<Root>/Input'
   */
  Outport = (uint8_T)Inport;
}

The generated code is more efficient without this protective code, but it is possible that the execution
of generated code does not produce the same results as simulation for values not in the range of 0 to
255.

See Also
“Remove code from floating-point to integer conversions that wraps out-of-range values”

 Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values

69-21



Related Examples
• “hisl_0053: Configuration Parameters > Code Generation > Optimization > Remove code from

floating-point to integer conversions that wraps out-of-range values”
• “Optimization Tools and Techniques” on page 69-7
• “Remove Code That Maps NaN to Integer Zero” on page 69-23
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Remove Code That Maps NaN to Integer Zero
In this section...
“Example Model” on page 69-23
“Generate Code” on page 69-23
“Generate Code with Optimization” on page 69-24

This example shows how to remove code that maps NaN to integer zero. For floating-point to integer
conversions involving saturation, Simulink converts NaN to integer zero during simulation. If your
model contains an input value of NaN, you can specify that the code generator produce code that
maps NaN to zero. Without this code, there is a mismatch between simulation and code generation
results because in Standard C, every condition involving NaN evaluates to false.

If input values of NaN doe not exist in your application, you can remove code that maps NaN to integer
zero. Removing this code reduces the size and increases the speed of the generated code.

Example Model
In this model, a Data Type Conversion block converts an input signal from a double to a uint8. In
this example, the model is named conversion_ex.

1 Use Inport, Outport, and Data Type Conversion blocks to create the example model.
2 Open the Inport Block Parameters dialog box and click the Signal Attributes tab. For the Data

Type parameter, select double.
3 Open the Data Type Conversion dialog box. For the Output data type parameter, select uint8.
4 Select Saturate on integer overflow. Selecting this parameter specifies that an out-of-range

signal value equals either the minimum or maximum value that the data type can represent.
5 For the signal feeding into the Data Type Conversion block, open the Signal Properties dialog

box. Enter a name of U. In the Code Mappings editor, under Signals, set the storage Class, to
ImportedExtern.

6 For the signal leaving the Data Type Conversion block, open the Signal Properties dialog box.
Enter a name of Y. In the Code Mappings editor, under Signals, set the storage class, to
ImportedExtern.

Generate Code
1 Set the Configuration Parameters > Solver > Solver options > Type parameter to Fixed-

step.
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2 Disable the Configuration Parameters > Optimization > Advanced parameters > Remove
code from floating-point to integer conversions with saturation that maps NaN to zero
parameter.

3 Enable the Configuration Parameters > Code Generation > Report > Create code
generation report parameter and the Open report automatically parameter.

4 Enable the Configuration Parameters > Code Generation > Build process > Generate
code only parameter. Then, in the model window, press Ctrl+B. When code generation is
complete, an HTML code generation report opens.

5 In the Code Generation report, select the nan_int_ex.c file and view the model step function.
For an input value of NaN, there is agreement between the generated code and simulation
because NaN maps to integer zero.

/* Model step function */
void nan_int_ex_step(void)
{
  /* DataTypeConversion: '<Root>/Data Type Conversion' incorporates:
   *  Inport: '<Root>/In1'
   */
  if (U < 256.0) {
    if (U >= 0.0) {
      Y = (uint8_T)U;
    } else {
      Y = 0U;
    }
  } else if (U >= 256.0) {
    Y = MAX_uint8_T;
  } else {
    Y = 0U;
  }

Generate Code with Optimization
1 Enable the Configuration Parameters > Optimization > Code generation > Integer and

fixed-point > Remove code from floating-point to integer conversions that wraps out-of-
range values parameter. Generate code.

2 In the Code Generation report, select the nan_int_ex.c section and view the model step
function. The generated code maps NaN to 255 and not integer zero. The generated code is more
efficient without the extra code that maps NaN to integer zero, but the execution of the generated
code does not produce the same results as simulation for NaN values.

/* Model step function */
void nan_int_ex_step(void)
{
  /* DataTypeConversion: '<Root>/Data Type Conversion' incorporates:
   *  Inport: '<Root>/In1'
   */
  if (U < 256.0) {
    if (U >= 0.0) {
      Y = (uint8_T)U;
    } else {
      Y = 0U;
    }
  } else {
    Y = MAX_uint8_T;
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  }
 
  /* End of DataTypeConversion: '<Root>/Data Type Conversion' */

See Also
“Remove code from floating-point to integer conversions with saturation that maps NaN to zero”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values” on

page 69-20
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Disable Nonfinite Checks or Inlining for Math Functions
When the code generator produces code for math functions:

• If the model option Support non-finite numbers is selected, nonfinite number checking is
generated uniformly for math functions, without the ability to specify that nonfinite number
checking should be generated for some functions, but not for others.

• By default, inlining is applied uniformly for math functions, without the ability to specify that
inlining should be generated for some functions, while invocations should be generated for others.

You can use code replacement library (CRL) customization entries to:

• Selectively disable nonfinite checks for math functions. This can improve the execution speed of
the generated code.

• Selectively disable inlining of math functions. This can increase code readability and decrease
code size.

The functions for which these customizations are supported include the following:

• Floating-point only: atan2, copysign, fix, hypot, log, log10, round, sincos, and sqrt
• Floating-point and integer: abs, max, min, mod, rem, saturate, and sign

The general workflow for disabling nonfinite number checking and/or inlining is as follows:

1 If you can disable nonfinite number checking for a particular math function, or if you want to
disable inlining for a particular math function and instead generate a function invocation, you
can copy the following MATLAB function code into a MATLAB file with an .m file name extension,
for example, crl_table_customization.m.
function hTable = crl_table_customization
    
% Create an instance of the Code Replacement Library table for controlling
% function intrinsic inlining and nonfinite support

hTable = RTW.TflTable;

% Inline - true (if function needs to be inline)
%          false (if function should not be inlined)
% SNF (support nonfinite) - ENABLE (if non-finite checking should be performed)
%                           DISABLE (if non-finite checking should NOT be performed)
%                           UNSPECIFIED (Default behavior)

% registerCustomizationEntry(hTable, ...
%       Priority, numInputs, key, inType, outType, Inline, SNF);

registerCustomizationEntry(hTable, ...
        100, 2, 'atan2', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'atan2', 'single', 'single', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'sincos', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sincos', 'single', 'single', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'single', 'single', true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'int32',  'int32',  true, 'UNSPECIFIED');
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registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'int16',  'int16',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'int8',   'int8',   true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'integer','integer',true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'abs', 'uint8',  'uint8',  true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 2, 'hypot', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'hypot', 'single', 'single', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'log', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'log', 'single', 'double', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'log10', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'log10', 'single', 'double', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'int32',  'int32',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'int16',  'int16',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'int8',   'int8',   true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'uint8',  'uint8',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'min', 'integer','integer',true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'int32',  'int32',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'int16',  'int16',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'int8',   'int8',   true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'uint8',  'uint8',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'max', 'integer','integer',true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'int32',  'int32',  false, 'UNSPECIFIED');
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registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'int16',  'int16',  false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'int8',   'int8',   false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'uint32', 'uint32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'uint16', 'uint16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'mod', 'uint8',  'uint8',  false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'int32',  'int32',  false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'int16',  'int16',  false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'int8',   'int8',   false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'uint32', 'uint32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'uint16', 'uint16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 2, 'rem', 'uint8',  'uint8',  false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'round', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'round', 'single', 'single', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'int32',  'int32',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'int16',  'int16',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'int8',   'int8',   true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'uint8',  'uint8',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 3, 'saturate', 'integer','integer',true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'double', 'double',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'single', 'single',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'int32',  'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'int16',  'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'int8',   'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'uint32', 'uint32',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'uint16', 'uint16',  true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'uint8',  'uint8',   true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sign', 'integer','integer', true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
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        100, 1, 'sqrt', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'sqrt', 'single', 'single', true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'fix', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'fix', 'single', 'single', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
        100, 1, 'copysign', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
        100, 1, 'copysign', 'single', 'single', true, 'UNSPECIFIED');

2 To reduce the size of the file, you can delete the registerCustomizationEntry lines for
functions for which the default nonfinite number checking and inlining behavior is acceptable.

3 For each remaining entry,

• Set the Inline argument to true if the function should be inlined or false if it should not
be inlined.

• Set the SNF argument to ENABLE if nonfinite checking should be generated, DISABLE if
nonfinite checking should not be generated, or UNSPECIFIED to accept the default behavior
based on the model option settings.

Save the file.
4 Optionally, perform a quick check of the syntactic validity of the customization table entries by

invoking the table definition file at the MATLAB command line (>> tbl =
crl_table_customization). Fix syntax errors that are flagged.

5 Optionally, view the customization table entries in the Code Replacement Viewer (>>
crviewer(crl_table_customization)). For more information about viewing code
replacement tables, see “Choose a Code Replacement Library”.

6 To register these changes and make them appear in the Code replacement library drop-down
list located on the Code Generation > Interface pane of the Configuration Parameters dialog
box, first copy the following MATLAB function code into an instance of the file
rtwTargetInfo.m.

Note For the example below, specify the argument 'RTW' if a GRT target is selected for your
model, otherwise omit the argument.

function rtwTargetInfo(cm)
% rtwTargetInfo function to register a code replacement library (CRL)

  % Register the CRL defined in local function locCrlRegFcn
  cm.registerTargetInfo(@locCrlRegFcn);

end % End of RTWTARGETINFO

% Local function to define a CRL containing crl_table_customization
function thisCrl = locCrlRegFcn

  % Instantiate a CRL registry entry - specify 'RTW' for GRT
  thisCrl = RTW.TflRegistry('RTW');

  % Define the CRL properties
  thisCrl.Name = 'CRL Customization Example';
  thisCrl.Description = 'Example  of CRL Customization';
  thisCrl.TableList = {'crl_table_customization'};
  thisCrl.TargetHWDeviceType = {'*'};
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end % End of LOCCRLREGFCN

You can edit the Name field to specify the library name that appears in the Code replacement
library drop-down list. Also, the file name in the TableList field must match the name of the
file you created in step 1.

To register your changes, with both of the MATLAB files you created present in the MATLAB
path, enter the following command at the MATLAB command line:

sl_refresh_customizations
7 Create or open a model that generates function code corresponding to one of the math functions

for which you specified a change in nonfinite number checking or inlining behavior.
8 Open the Configuration Parameters dialog box, go to the Code Generation > Interface pane,

and use the Code replacement library drop-down list to select the code replacement entry you
registered in step 6, for example, CRL Customization Example.

9 Generate code for the model and examine the generated code to verify that the math functions
are generated as expected.

69 Optimizations for Generated Code in Simulink Coder

69-30



Fold Expressions
Expression folding optimizes code to minimize the computation of intermediate results at block
outputs and the storage of such results in temporary buffers or variables. When expression folding is
on, the code generator collapses (folds) block computations into a single expression, instead of
generating separate code statements and storage declarations for each block in a model. Most
Simulink blocks support expression folding.

Expression folding improves the efficiency of generated code, frequently achieving results that
compare favorably to hand-optimized code. In many cases, entire groups of model computations fold
into a single, highly optimized line of code.

Example Model

model = 'rtwdemo_slexprfold';
open_system(model);

Generate Code

Expression folding is available only when the Signal storage reuse parameter is set to on because
expression folding operates only on expressions involving local variables. The Signal storage reuse
and Eliminate superfluous local variables (expression folding) parameters are on by default.
Clear the Eliminate superfluous local variables (expression folding) parameter or enter the
following command in the MATLAB Command Window to turn the parameter off:

set_param(model, 'ExpressionFolding','off');

Create a temporary folder for the build and inspection process.
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currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_slexprfold
### Successful completion of build procedure for: rtwdemo_slexprfold

Build Summary

Top model targets built:

Model               Action                       Rebuild Reason                                    
===================================================================================================
rtwdemo_slexprfold  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.355s

With expression folding off, in the rtwdemo_slexprfold.c file, there are separate code statements
before and in the Switch block operation.

cfile = fullfile(cgDir,'rtwdemo_slexprfold_grt_rtw','rtwdemo_slexprfold.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_slexprfold_step(void)
{
  real_T rtb_Gain;
  boolean_T rtb_LogicalOperator;
  boolean_T rtb_RelationalOperator;

  /* RelationalOperator: '<Root>/Relational Operator1' incorporates:
   *  Constant: '<Root>/Constant'
   *  Inport: '<Root>/In2'
   */
  rtb_LogicalOperator = (rtwdemo_slexprfold_P.UPPER >= rtwdemo_slexprfold_U.In2);

  /* RelationalOperator: '<Root>/Relational Operator' incorporates:
   *  Constant: '<Root>/Constant1'
   *  Inport: '<Root>/In2'
   */
  rtb_RelationalOperator = (rtwdemo_slexprfold_U.In2 <=
    rtwdemo_slexprfold_P.LOWER);

  /* Logic: '<Root>/Logical Operator' */
  rtb_LogicalOperator = (rtb_LogicalOperator || rtb_RelationalOperator);

  /* Switch: '<Root>/Switch' */
  if (rtb_LogicalOperator) {
    /* Gain: '<Root>/Gain' incorporates:
     *  Inport: '<Root>/In1'
     */
    rtb_Gain = 2.0 * rtwdemo_slexprfold_U.In1;
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    /* Lookup_n-D: '<Root>/Look-Up Table' incorporates:
     *  Gain: '<Root>/Gain'
     */
    rtwdemo_slexprfold_Y.Out1 = look1_binlx(rtb_Gain,
      rtwdemo_slexprfold_P.T1Break, rtwdemo_slexprfold_P.T1Data, 10U);
  } else {
    /* Lookup_n-D: '<Root>/Look-Up Table' incorporates:
     *  Inport: '<Root>/In3'
     *  Inport: '<Root>/In4'
     *  Lookup_n-D: '<Root>/Look-Up Table (2-D)'
     */
    rtwdemo_slexprfold_Y.Out1 = look2_binlx(rtwdemo_slexprfold_U.In3,
      rtwdemo_slexprfold_U.In4, rtwdemo_slexprfold_P.T2Break,
      rtwdemo_slexprfold_P.T2Break, rtwdemo_slexprfold_P.T2Data,
      rtCP_LookUpTable2D_maxIndex, 3U);
  }

  /* End of Switch: '<Root>/Switch' */
}

Generate Code with Optimization

Enter the following command to turn expression folding on:

set_param(model, 'ExpressionFolding','on');

Build the model.

slbuild(model);

### Starting build procedure for: rtwdemo_slexprfold
### Successful completion of build procedure for: rtwdemo_slexprfold

Build Summary

Top model targets built:

Model               Action                       Rebuild Reason                   
==================================================================================
rtwdemo_slexprfold  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.426s

The following is a portion of rtwdemo_slexprfold.c. In the optimized code, the code generator folds all
computations into the Switch block operation.

rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_slexprfold_step(void)
{
  /* Switch: '<Root>/Switch' incorporates:
   *  Constant: '<Root>/Constant'
   *  Constant: '<Root>/Constant1'
   *  Inport: '<Root>/In2'
   *  Logic: '<Root>/Logical Operator'
   *  RelationalOperator: '<Root>/Relational Operator'
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   *  RelationalOperator: '<Root>/Relational Operator1'
   */
  if ((rtwdemo_slexprfold_P.UPPER >= rtwdemo_slexprfold_U.In2) ||
      (rtwdemo_slexprfold_U.In2 <= rtwdemo_slexprfold_P.LOWER)) {
    /* Outport: '<Root>/Out1' incorporates:
     *  Gain: '<Root>/Gain'
     *  Inport: '<Root>/In1'
     *  Lookup_n-D: '<Root>/Look-Up Table'
     */
    rtwdemo_slexprfold_Y.Out1 = look1_binlx(2.0 * rtwdemo_slexprfold_U.In1,
      rtwdemo_slexprfold_P.T1Break, rtwdemo_slexprfold_P.T1Data, 10U);
  } else {
    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/In3'
     *  Inport: '<Root>/In4'
     *  Lookup_n-D: '<Root>/Look-Up Table (2-D)'
     */
    rtwdemo_slexprfold_Y.Out1 = look2_binlx(rtwdemo_slexprfold_U.In3,
      rtwdemo_slexprfold_U.In4, rtwdemo_slexprfold_P.T2Break,
      rtwdemo_slexprfold_P.T2Break, rtwdemo_slexprfold_P.T2Data,
      rtCP_LookUpTable2D_maxIndex, 3U);
  }

  /* End of Switch: '<Root>/Switch' */
}

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

For an example in which code expressions are expression folded between Simulink and Stateflow,
open this model rtwdemo_sfexprfold.
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Minimize Computations and Storage for Intermediate Results
at Block Outputs

In this section...
“Expression Folding” on page 69-35
“Example Model” on page 69-35
“Generate Code” on page 69-35
“Enable Optimization” on page 69-36
“Generate Code with Optimization” on page 69-36

Expression Folding
Expression folding optimizes code to minimize the computation of intermediate results at block
outputs and the storage of such results in temporary buffers or variables. When expression folding is
on, the code generator collapses (folds) block computations into a single expression, instead of
generating separate code statements and storage declarations for each block in the model. Most
Simulink blocks support expression folding.

Expression folding improves the efficiency of generated code, frequently achieving results that
compare favorably to hand-optimized code. In many cases, entire groups of model computations fold
into a single, highly optimized line of code.

You can use expression folding in your own inlined S-function blocks. For more information, see “S-
Functions That Support Expression Folding”.

Example Model

Generate Code
With expression folding off, in the explfld.c file, the code generator generates this code.

/* Model step function */
void exprfld_step(void)
{
  /* Gain: '<Root>/Gain' incorporates:
   *  Inport: '<Root>/In1'
   */
  exprfld_B.S1 = exprfld_P.Gain_Gain * exprfld_U.i1;
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  /* Gain: '<Root>/Gain1' incorporates:
   *  Inport: '<Root>/In2'
   */
  exprfld_B.S2 = exprfld_P.Gain1_Gain * exprfld_U.i2;
 
  /* Outport: '<Root>/Out1' incorporates:
   *  Product: '<Root>/Product'
   */
  exprfld_Y.Out1 = exprfld_B.S1 * exprfld_B.S2;
}

There are separate code statements for both Gain blocks. Before final output, these code statements
compute temporary results for the Gain blocks.

Enable Optimization
Expression folding is on by default. To see if expression folding is on for an existing model:

1 Expression folding is available only when the Configuration Parameters > Signal storage
reuse parameter is selected because expression folding operates only on expressions involving
local variables. Enable the Signal storage reuse parameter.

2 When you select Signal storage reuse, the Enable local block outputs, Reuse local block
outputs, and Eliminate superfluous local variables (expression folding) parameters are all
on by default.

Generate Code with Optimization
With expression folding, the code generator generates a single-line output computation, as shown in
the expfld.c file. The generated comments document the block parameters that appear in the
expression.

/* Model step function */
void exprfld_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   *  Gain: '<Root>/Gain1'
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Product: '<Root>/Product'
   */
  exprfld_Y.Out1 = 
     exprfld_P.Gain_Gain * 
     exprfld_U.i1 * 
     (exprfld_P.Gain1_Gain * exprfld_U.i2);
}

For an example of expression folding in the context of a more complex model, click
rtwdemo_slexprfold , or at the command prompt, type:

rtwdemo_slexprfold

For more information, see “Enable and Reuse Local Block Outputs in Generated Code”
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See Also
“Signal storage reuse” | “Reuse local block outputs” | “Enable local block outputs” | “Eliminate
superfluous local variables (Expression folding)”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “C Code Generation Configuration for Model Interface Elements” on page 33-2
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Inline Invariant Signals
You can optimize the generated code by selecting Inline invariant signals on the Optimization
pane. The generated code uses the numerical values of the invariant signals instead of their symbolic
names.

An invariant signal is a block output signal that does not change during Simulink simulation. For
example, the signal S3 is an invariant signal. An invariant signal is not the same as an invariant
constant. The two constants (1 and 2) and the gain value of 3 are invariant constants. To inline
invariant constants, set Default parameter behavior to Inlined.

Optimize Generated Code Using Inline Invariant Signals
This example shows how to use inline invariant signals to optimize the generated code. This
optimization transforms symbolic names of invariant signals into constant values.

The InlineInvariantSignals optimization:

• Reduces ROM and RAM consumption.
• Improves execution speed.

Example Model

Consider the model rtwdemo_inline_invariant_signals.

model = 'rtwdemo_inline_invariant_signals';
open_system(model);

Generate Code

Create a temporary folder (in your system temporary folder) for the build and inspection process.
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currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model using Simulink Coder.

slbuild(model)

### Starting build procedure for: rtwdemo_inline_invariant_signals
### Successful completion of build procedure for: rtwdemo_inline_invariant_signals

Build Summary

Top model targets built:

Model                             Action                       Rebuild Reason                                    
=================================================================================================================
rtwdemo_inline_invariant_signals  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 19.188s

View the generated code without the optimization. These lines of code are in
rtwdemo_inline_invariant_signals.c.

cfile = fullfile(cgDir,'rtwdemo_inline_invariant_signals_grt_rtw',...
    'rtwdemo_inline_invariant_signals.c');
rtwdemodbtype(cfile,'/* Output and update for atomic system',...
    '/* Model output', 1, 0);

/* Output and update for atomic system: '<Root>/InlinedConstFcn' */
void rtwdemo_inline__InlinedConstFcn(int32_T rtu_In1,
  B_InlinedConstFcn_rtwdemo_inl_T *localB, const ConstB_InlinedConstFcn_rtwdem_T
  *localC)
{
  /* Product: '<S1>/Product' */
  localB->Product = rtu_In1 * localC->Sum_p;
}

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, select Inline Invariant Signals.

Alternatively, you can use the command-line API to enable the optimization:

set_param(model, 'InlineInvariantSignals', 'on');

Generate Code with Optimization

The generated code uses the numerical values of the folded constants instead of creating an
additional structure (rtwdemo_inline_invariant_ConstB).

Build the model using Simulink Coder.

slbuild(model)

### Starting build procedure for: rtwdemo_inline_invariant_signals
### Successful completion of build procedure for: rtwdemo_inline_invariant_signals
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Build Summary

Top model targets built:

Model                             Action                       Rebuild Reason                   
================================================================================================
rtwdemo_inline_invariant_signals  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.264s

View the generated code with the optimization. These lines of code are in rtwdemo_minmax.c.

rtwdemodbtype(cfile,...
    '/* Output and update for atomic system', '/* Model output', 1, 0);

/* Output and update for atomic system: '<Root>/InlinedConstFcn' */
void rtwdemo_inline__InlinedConstFcn(int32_T rtu_In1,
  B_InlinedConstFcn_rtwdemo_inl_T *localB)
{
  /* Product: '<S1>/Product' */
  localB->Product = rtu_In1 << 5;
}

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Inline invariant signals”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Inline Numeric Values of Block Parameters” on page 69-41
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Inline Numeric Values of Block Parameters
This example shows how to optimize the generated code by inlining the numeric values of block
parameters. Block parameters include the Gain parameter of a Gain block and the table data and
breakpoint sets of an n-D Lookup Table block.

This optimization determines whether numeric block parameters occupy global memory in the
generated code. The optimization can:

• Improve execution speed.
• Reduce RAM and ROM consumption.

Explore Example Model

Open the example model rtwdemo_paraminline and configure it to show the generated names of
blocks.

load_system('rtwdemo_paraminline')
set_param('rtwdemo_paraminline','HideAutomaticNames','off')
open_system('rtwdemo_paraminline')

The model contains blocks that have these numeric parameters:

• The Gain parameters of the Gain blocks
• The Constant value parameters of the Constant blocks
• The table data and breakpoint sets of the n-D Lookup Table blocks

The output of the block G2, and the outputs of blocks upstream of G2, change only if you tune the
values of the block parameters during simulation or during code execution. When you update the
model diagram, these blocks and signal lines appear magenta in color.
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Several blocks use Simulink.Parameter objects in the base workspace to set the values of their
parameters. The parameter objects all use the storage class Auto, which means that you can
configure the generated code to inline the parameter values.

Generate Code Without Optimization

Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Disable the optimization by setting Configuration Parameters > Default parameter behavior to
Tunable.

set_param('rtwdemo_paraminline','DefaultParameterBehavior','Tunable')

Generate code from the model.

slbuild('rtwdemo_paraminline')

### Starting build procedure for: rtwdemo_paraminline
### Successful completion of build procedure for: rtwdemo_paraminline

Build Summary

Top model targets built:

Model                Action                       Rebuild Reason                                    
====================================================================================================
rtwdemo_paraminline  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.903s

In the code generation report, view the source file rtwdemo_paraminline_data.c. The code
defines a global structure that contains the block parameter values. Each block parameter in the
model, such as a lookup table array, breakpoint set, or gain, appears as a field of the structure.

cfile = fullfile(...
    cgDir,'rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline_data.c');
rtwdemodbtype(cfile,'/* Block parameters (default storage) */', '};', 1, 1);

/* Block parameters (default storage) */
P_rtwdemo_paraminline_T rtwdemo_paraminline_P = {
  /* Variable: MAX_LIFT
   * Referenced by: '<Root>/Constant'
   */
  10.0,

  /* Variable: SLIDER_POS
   * Referenced by: '<Root>/Constant1'
   */
  0.0,

  /* Variable: T1Break
   * Referenced by: '<Root>/1D Lookup'
   */
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  { -5.0, -4.0, -3.0, -2.0, -1.0, 0.0, 1.0, 2.0, 3.0, 4.0, 5.0 },

  /* Variable: T1Data
   * Referenced by: '<Root>/1D Lookup'
   */
  { -1.0, -0.99, -0.98, -0.96, -0.76, 0.0, 0.76, 0.96, 0.98, 0.99, 1.0 },

  /* Variable: T2Break
   * Referenced by: '<Root>/2D Lookup'
   */
  { 1.0, 2.0, 3.0 },

  /* Variable: T2Data
   * Referenced by: '<Root>/2D Lookup'
   */
  { 4.0, 16.0, 10.0, 5.0, 19.0, 18.0, 6.0, 20.0, 23.0 },

  /* Expression: 2
   * Referenced by: '<Root>/G1'
   */
  2.0,

  /* Expression: -2
   * Referenced by: '<Root>/G2'
   */
  -2.0,

  /* Computed Parameter: uDLookup_maxIndex
   * Referenced by: '<Root>/2D Lookup'
   */
  { 2U, 2U }
};

You can tune the structure fields during code execution because they occupy global memory.
However, at each step of the generated algorithm, the code must calculate the output of each block,
including the outputs of the block G2 and the upstream blocks. View the algorithm in the model step
function in the file rtwdemo_paraminline.c.

cfile = fullfile(cgDir,'rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.c');
rtwdemodbtype(...
    cfile,'/* Model step function */','/* Model initialize function */',1,0);

/* Model step function */
void rtwdemo_paraminline_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Constant: '<Root>/Constant'
   *  Constant: '<Root>/Constant1'
   *  Gain: '<Root>/G1'
   *  Gain: '<Root>/G2'
   *  Inport: '<Root>/In1'
   *  Lookup_n-D: '<Root>/1D Lookup'
   *  Lookup_n-D: '<Root>/2D Lookup'
   *  Sum: '<Root>/Sum'
   */
  rtwdemo_paraminline_Y.Out1 = rtwdemo_paraminline_P.G1_Gain *
    rtwdemo_paraminline_U.In1 + rtwdemo_paraminline_P.G2_Gain * look2_binlx
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    (rtwdemo_paraminline_P.MAX_LIFT, look1_binlx
     (rtwdemo_paraminline_P.SLIDER_POS, rtwdemo_paraminline_P.T1Break,
      rtwdemo_paraminline_P.T1Data, 10U), rtwdemo_paraminline_P.T2Break,
     rtwdemo_paraminline_P.T2Break, rtwdemo_paraminline_P.T2Data,
     rtwdemo_paraminline_P.uDLookup_maxIndex, 3U);
}

Generate Code with Optimization

Set Default parameter behavior to Inlined.

set_param('rtwdemo_paraminline','DefaultParameterBehavior','Inlined')

Generate code from the model.

slbuild('rtwdemo_paraminline')

### Starting build procedure for: rtwdemo_paraminline
### Successful completion of build procedure for: rtwdemo_paraminline

Build Summary

Top model targets built:

Model                Action                       Rebuild Reason                         
=========================================================================================
rtwdemo_paraminline  Code generated and compiled  Global variable MAX_LIFT has changed.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.25s

In the code generation report, view the algorithm in the file rtwdemo_paraminline.c.

rtwdemodbtype(...
    cfile,'/* Model step function */','/* Model initialize function */',1,0);

/* Model step function */
void rtwdemo_paraminline_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/G1'
   *  Inport: '<Root>/In1'
   *  Sum: '<Root>/Sum'
   */
  rtwdemo_paraminline_Y.Out1 = 2.0 * rtwdemo_paraminline_U.In1 + 150.0;
}

The code does not allocate memory for block parameters or for parameter objects that use the
storage class Auto. Instead, the code generator uses the parameter values from the model, and from
the parameter objects, to calculate and inline the constant output of the block G2, 150.0. The
generator also inlines the value of the Gain parameter of the Gain block G1, 2.0.

With the optimization, the generated code leaves out computationally expensive algorithmic code for
blocks such as the lookup tables. The optimized code calculates the output of a block only if the
output can change during execution. For this model, only the outputs of the Inport block In1, the Gain
block G1, and the Sum block can change.

Close the model and the code generation report.
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bdclose('rtwdemo_paraminline')
rtwdemoclean;
cd(currentDir)

Preserve Block Parameter Tunability

When you set Default parameter behavior to Inlined, you can preserve block parameter
tunability by creating Simulink.Parameter objects for individual parameters. You can configure
each object to appear in the code as a tunable field of the global parameter structure or as an
individual global variable. You can change parameter values during code execution and interface the
generated code with your own handwritten code. For more information, see “Create Tunable
Calibration Parameter in the Generated Code”.

Inline Invariant Signals

You can select the Inline invariant signals code generation option (which also places constant
values in the generated code) only when you set Default parameter behavior to Inlined. See
“Inline Invariant Signals”.

See Also
“Default parameter behavior”

Related Examples
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Configure Loop Unrolling Threshold
The Loop unrolling threshold parameter on the Optimization pane determines when a wide signal
or parameter should be wrapped into a for loop and when it should be generated as a separate
statement for each element of the signal. The default threshold value is 5.

For example, consider the model below:

The gain parameter of the Gain block is the vector myGainVec.

Assume that the loop unrolling threshold value is set to the default, 5.

If myGainVec is declared as

myGainVec = [1:10];

an array of 10 elements, myGainVec_P.Gain_Gain[], is declared within the Parameters_model
data structure. The size of the gain array exceeds the loop unrolling threshold. Therefore, the code
generated for the Gain block iterates over the array in a for loop, as shown in the following code:

{
    int32_T i1;

    /* Gain: '<Root>/Gain' */
    for(i1=0; i1<10; i1++) {
      myGainVec_B.Gain_f[i1] = rtb_foo *
        myGainVec_P.Gain_Gain[i1];
    }
  }

If myGainVec is declared as

myGainVec = [1:3];
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an array of three elements, myGainVec_P.Gain_Gain[], is declared within the Parameters data
structure. The size of the gain array is below the loop unrolling threshold. The generated code
consists of inline references to each element of the array, as in the code below.

/* Gain: '<Root>/Gain' */
  myGainVec_B.Gain_f[0] = rtb_foo * myGainVec_P.Gain_Gain[0];
  myGainVec_B.Gain_f[1] = rtb_foo * myGainVec_P.Gain_Gain[1];
  myGainVec_B.Gain_f[2] = rtb_foo * myGainVec_P.Gain_Gain[2];

See “Explore Variable Names and Loop Rolling” for more information on loop rolling.

Note When a model includes Stateflow charts or MATLAB Function blocks, you can apply a set of
Stateflow optimizations on the Optimization pane. The settings you select for the Stateflow options
also apply to MATLAB Function blocks in the model. This is because the MATLAB Function blocks and
Stateflow charts are built on top of the same technology and share a code base. You do not need a
Stateflow license to use MATLAB Function blocks.

Note If your MATLAB Function block contains code with two nested for-loops:

• If the number of iterations of the inner loop is less than the threshold, the code generator first
unrolls the inner loop. Subsequently, if the product of the number of iterations of the two loops is
also less than the threshold, the code generator unrolls the outer loop. Otherwise the code
generator produces the outer for-loop.

• If the number of iterations of the inner loop is equal to or greater than the threshold, the code
generator produces both for-loops

• For an N-Dimensional array the code generator unrolls each contiguous loop until the product of
loop iterations is less than the threshold value.

See Also
“Loop unrolling threshold”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Optimize Generated Code by Combining Multiple for Constructs” on page 69-13
• “For Loop” on page 25-31
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Use memcpy Function to Optimize Generated Code for Vector
Assignments

In this section...
“Example Model” on page 69-48
“Generate Code” on page 69-49
“Generate Code with Optimization” on page 69-50

You can use the Use memcpy for vector assignment parameter to optimize generated code for
vector assignments by replacing for loops with memcpy function calls. The memcpy function is more
efficient than for-loop controlled element assignment for large data sets. This optimization improves
execution speed.

Selecting the Use memcpy for vector assignment parameter enables the associated parameter
Memcpy threshold (bytes), which allows you to specify the minimum array size in bytes for which
memcpy function calls should replace for loops in the generated code. For more information, see
“Use memcpy for vector assignment” and “Memcpy threshold (bytes)”. In considering whether to use
this optimization,

• Verify that your target supports the memcpy function.
• Determine whether your model uses signal vector assignments (such as Y=expression) to move

large amounts of data, for example, using the Selector block.

To apply this optimization,

1 Consider first generating code without this optimization and measuring its execution speed, to
establish a baseline for evaluating the optimized assignment.

2 Select Use memcpy for vector assignment and examine the setting of Memcpy threshold
(bytes), which by default specifies 64 bytes as the minimum array size for which memcpy
function calls replace for loops. Based on the array sizes used in your application's signal vector
assignments, and target environment considerations that might bear on the threshold selection,
accept the default or specify another array size.

3 Generate code, and measure its execution speed against your baseline or previous iterations.
Iterate on steps 2 and 3 until you achieve an optimal result.

Note The memcpy optimization may not occur under certain conditions, including when other
optimizations have a higher precedence than the memcpy optimization, or when the generated code is
originating from Target Language Compiler (TLC) code, such as a TLC file associated with an S-
function block.

Note If you are licensed for Embedded Coder software, you can use a code replacement library
(CRL) to provide your own custom implementation of the memcpy function to be used in generated
model code. For more information, see “Memory Function Code Replacement” on page 67-71.

Example Model
To examine the result of using the Use memcpy for vector assignment parameter on the generated
vector assignment code, create a model that generates signal vector assignments. For example,
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1 Use In, Out, and Selector blocks to create the following model.

2 Open Model Explorer and configure the Signal Attributes for the In1 and In2 source blocks.
For each, set Port dimensions to [1,100], and set Data type to int32. Apply the changes and
save the model. In this example, the model has the name vectorassign.

3 For each Selector block, set the Index parameter to 1:50. Set the Input port size parameter to
100.

Generate Code
1 The Use memcpy for vector assignment parameter is on by default. To turn off the parameter,

go to the Optimization pane and clear the Use memcpy for vector assignment parameter.
2 Go to the Code Generation > Report pane of the Configuration Parameters dialog box and

select the Create code generation report parameter and the Open report automatically
parameter. Then go to the Code Generation pane, select the Generate code only option, and
generate code for the model. When code generation completes, the HTML code generation
report is displayed.

3 In the HTML code generation report, click the vectorassign.c section and inspect the model
step function. Notice that the vector assignments are implemented using for loops.
/* Model step function */
void vectorassign_step(void)
{
  int32_T i;
  for (i = 0; i < 50; i++) {
    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/In1'
     */
    vectorassign_Y.Out1[i] = vectorassign_U.In1[i];

    /* Outport: '<Root>/Out2' incorporates:
     *  Inport: '<Root>/In2'
     */
    vectorassign_Y.Out2[i] = vectorassign_U.In2[i];
  }
}
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Generate Code with Optimization
1 Go to the Optimization pane of the Configuration Parameters dialog box and select the Use

memcpy for vector assignment option. Leave the Memcpy threshold (bytes) option at its
default setting of 64. Apply the changes and regenerate code for the model. When code
generation completes, the HTML code generation report again is displayed.

2 In the HTML code generation report, click the vectorassign.c section and inspect the model
output function. Notice that the vector assignments now are implemented using memcpy function
calls.
/* Model step function */
void vectorassign_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   */
  memcpy(&vectorassign_Y.Out1[0], &vectorassign_U.In1[0], 50U * sizeof(real_T));

  /* Outport: '<Root>/Out2' incorporates:
   *  Inport: '<Root>/In2'
   */
  memcpy(&vectorassign_Y.Out2[0], &vectorassign_U.In2[0], 50U * sizeof(real_T));
}

See Also
“Use memcpy for vector assignment”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Vector Operation Optimization” on page 69-97
• “Convert Data Copies to Pointer Assignments” on page 73-18
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Generate Target Optimizations Within Algorithm Code
Some application components are hardware-specific and cannot simulate on a host system. For
example, consider a component that includes pragmas and assembly code for enabling hardware
instructions for saturate on add operations or a Fast Fourier Transform (FFT) function.

The following table lists integration options to customize generated algorithm code with target-
specific optimizations.

Note Solutions marked with EC only require an Embedded Coder license.

If... Then... For More Information, See
You want to optimize the
execution speed and
memory of the model code
by replacing default math
functions and operators
with target-specific code

EC only—Implement
function and operator
replacements by using the
Code Replacement Tool,
code replacement library
(CRL) API, and Code
Replacement Viewer to
create, examine, validate,
and register hardware-
specific replacement
tables

“Optimize Generated Code By Developing and Using
Code Replacement Libraries - Simulink®” on page 72-
27

You want to control how
code generation technology
declares, stores, and
represents signals, tunable
parameters, block states,
and data objects in
generated code

EC only—Design (create)
and apply custom storage
classes

• rtwdemo_cscpredef
• rtwdemo_importstruct
• rtwdemo_configinterface
• “Organize Parameter Data into a Structure by

Using Struct Storage Class” on page 33-68

Note To simulate an algorithm that includes target-specific elements in a host environment, you
must create code that is equivalent to the target code and can run in the host environment.
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Remove Code for Blocks That Have No Effect on Computational
Results

This example shows how the code generator optimizes generated code by removing code that has no
effect on computational results. This optimization:

• Increases execution speed.
• Reduces ROM consumption.

Example

In the model rtwdemo_blockreduction, a Gain block of value 1.0 is in between Inport and Outport
blocks.

model = 'rtwdemo_blockreduction';
open_system(model);

Generate Code

Create a temporary folder for the build and inspection process.

currentDir=pwd;
[~,cgDir]=rtwdemodir();

Build the model.

set_param(model,'BlockReduction','off');
slbuild(model)

### Starting build procedure for: rtwdemo_blockreduction
### Successful completion of build procedure for: rtwdemo_blockreduction

Build Summary

Top model targets built:

Model                   Action                       Rebuild Reason                                    
=======================================================================================================
rtwdemo_blockreduction  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.107s

Here is the code from rtwdemo_blockreduction.c.
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cfile = fullfile(cgDir,'rtwdemo_blockreduction_ert_rtw','rtwdemo_blockreduction.c');
rtwdemodbtype(cfile, '/* Model step function */',...
    '/* Model initialize function */', 1, 0);

/* Model step function */
void rtwdemo_blockreduction_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/In1'
   */
  rtwdemo_blockreduction_Y.Out1 = 1.0 * rtwdemo_blockreduction_U.In1;
}

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 Select Block reduction. This optimization is on by default.

Alternately, use the command-line API to enable the optimization.

set_param(model,'BlockReduction','on');

Generate Code with Optimization

slbuild(model)

### Starting build procedure for: rtwdemo_blockreduction
### Successful completion of build procedure for: rtwdemo_blockreduction

Build Summary

Top model targets built:

Model                   Action                       Rebuild Reason                   
======================================================================================
rtwdemo_blockreduction  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.995s

Here is the optimized code from rtwdemo_blockreduction.c.

cfile = fullfile(cgDir,'rtwdemo_blockreduction_ert_rtw','rtwdemo_blockreduction.c');
rtwdemodbtype(cfile, '/* Model step function */',...
    '/* Model initialize function */', 1, 0);

/* Model step function */
void rtwdemo_blockreduction_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtwdemo_blockreduction_Y.Out1 = rtwdemo_blockreduction_U.In1;
}
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Because multiplying the input signal by a value of 1.0 does not impact computational results, the
code generator excludes the Gain block from the generated code. Close the model and clean up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Block reduction”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Inline Numeric Values of Block Parameters” on page 69-41
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
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Eliminate Dead Code Paths in Generated Code
This example shows how the code generator eliminates dead (that is, unused) code paths from
generated code. This optimization increases execution speed and conserves ROM and RAM
consumption.

Example

In the model rtwdemo_deadpathElim, the signal leaving the Sum block divides into two separate code
paths. The top path is not a dead code path. If the user disables the Assertion block, the bottom path
becomes a dead code path.

model = 'rtwdemo_deadpathElim';
open_system(model);

Generate Code with an Enabled Assertion Block

1 For the Assertion block, open the block parameters dialog box.
2 Select the Enable assertion box. Alternatively, use the command-line API to enable the

Assertion block.

set_param([model '/Assert1'], 'Enabled', 'on');

Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_deadpathElim
### Successful completion of build procedure for: rtwdemo_deadpathElim

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
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rtwdemo_deadpathElim  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 9.957s

Because the Assertion block is enabled, these lines of rtwdemo_deadpathElim.c include code for
the Gain and Assertion blocks.

cfile = fullfile(cgDir,'rtwdemo_deadpathElim_grt_rtw','rtwdemo_deadpathElim.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize function */', 0, 1);

void rtwdemo_deadpathElim_step(void)
{
  /* Sum: '<Root>/Sum1' incorporates:
   *  Constant: '<Root>/Constant1'
   *  Inport: '<Root>/In1'
   */
  rtwdemo_deadpathElim_Y.Out1 = rtwdemo_deadpathElim_U.In1 + 1.0;

  /* Assertion: '<Root>/Assert1' incorporates:
   *  Gain: '<Root>/G1'
   */
  utAssert(2.0 * rtwdemo_deadpathElim_Y.Out1 != 0.0);
}

Generate Code with a Disabled Assertion Block

Disable the Assertion block to generate a dead code path. The code generator detects the dead code
path and eliminates it from the generated code.

1 For the Assertion block, open the Block Parameters dialog box.
2 Deselect the Enable assertion box.

Alternatively, use the command-line API to disable the Assertion block.

set_param([model '/Assert1'], 'Enabled', 'off');

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_deadpathElim
### Successful completion of build procedure for: rtwdemo_deadpathElim

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                   
====================================================================================
rtwdemo_deadpathElim  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 9.96s

Because the Assertion block is disabled, these lines of rtwdemo_deadpathElim.c do not include
code for the Gain and Assertion blocks.
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rtwdemodbtype(cfile,'/* Model step', '/* Model initialize function */', 0, 1);

void rtwdemo_deadpathElim_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Constant: '<Root>/Constant1'
   *  Inport: '<Root>/In1'
   *  Sum: '<Root>/Sum1'
   */
  rtwdemo_deadpathElim_Y.Out1 = rtwdemo_deadpathElim_U.In1 + 1.0;
}

Close the model and clean-up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

For another example of how the code generator eliminates dead code paths in the generated code,
see rtwdemo_deadpath.

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Remove Code for Blocks That Have No Effect on Computational Results” on page 69-52
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Floating-Point Multiplication to Handle a Net Slope Correction
This example shows how to use floating-point multiplication to handle a net slope correction. When
converting floating-point data types to fixed-point data types in the generated code, a net slope
correction is one method of scaling fixed-point data types. Scaling the fixed-point data types avoids
overflow conditions and minimizes quantization errors.

For processors that support efficient multiplication, using floating-point multiplication to handle a net
slope correction improves code efficiency. If the net slope correction has a value that is not a power of
two, using division improves precision.

Note: This example requires a Fixed-Point Designer™ license.

Example

In the model rtwdemo_float_mul_for_net_slope_correction, a Convert block converts an input signal
from a floating-point data type to a fixed-point data type. The net slope correction has a value of 3.

model = 'rtwdemo_float_mul_for_net_slope_correction';
open_system(model);

Generate Code

Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_float_mul_for_net_slope_correction
### Successful completion of build procedure for: rtwdemo_float_mul_for_net_slope_correction

Build Summary

Top model targets built:

Model                                       Action                       Rebuild Reason                                    
===========================================================================================================================
rtwdemo_float_mul_for_net_slope_correction  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.123s
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In these lines of rtwdemo_float_mul_for_net_slope_correction.c code, the code generator
divides the input signal by 3.0F .

cfile = fullfile(cgDir,'rtwdemo_float_mul_for_net_slope_correction_ert_rtw',...
    'rtwdemo_float_mul_for_net_slope_correction.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_float_mul_for_net_slope_correction_step(void)
{
  /* Outport: '<Root>/Output' incorporates:
   *  DataTypeConversion: '<Root>/Data Type Conversion'
   *  Inport: '<Root>/Input'
   */
  rtY.Output = (int16_T)(real32_T)floor((real_T)(rtU.Input / 3.0F));
}

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Math and Data Types pane, select Use floating-point multiplication to handle net

slope corrections. This optimization is on by default.

Alternatively, you can use the command-line API to enable the optimization.

set_param(model, 'UseFloatMulNetSlope', 'on');

Generate Code with Optimization

slbuild(model)

### Starting build procedure for: rtwdemo_float_mul_for_net_slope_correction
### Successful completion of build procedure for: rtwdemo_float_mul_for_net_slope_correction

Build Summary

Top model targets built:

Model                                       Action                       Rebuild Reason                   
==========================================================================================================
rtwdemo_float_mul_for_net_slope_correction  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.407s

In the optimized code, the code generator multiplies the input signal by the reciprocal of 3.0F , that
is 0.333333343F .

rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_float_mul_for_net_slope_correction_step(void)
{
  /* Outport: '<Root>/Output' incorporates:
   *  DataTypeConversion: '<Root>/Data Type Conversion'
   *  Inport: '<Root>/Input'
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   */
  rtY.Output = (int16_T)(real32_T)floor((real_T)(rtU.Input * 0.333333343F));
}

Close the model and the code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Use floating-point multiplication to handle net slope corrections”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values” on

page 69-20
• “Subnormal Number Execution Speed” on page 69-16
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Use Conditional Input Branch Execution
This example shows how to optimize the generated code for a model that contains Switch and
Multiport Switch blocks. When you select the model configuration parameter Conditional input
branch execution, Simulink executes only blocks that compute the control input and data input that
the control input selects. This optimization improves execution speed.

Example Model

In this example, switch paths are conditionally executed. If Switch1 control input is true, Switch1
executes blocks grouped in the Switch1:Path1 branch. If Switch1 control input is false, Switch1
executes blocks grouped in the Switch1:Path2 branch. If Switch1 executes blocks in the
Switch1:Path2 branch and Switch2 control input is true, Switch2 executes blocks in the
Switch2:Path1 branch. If Switch2 control input is false, Switch2 executes blocks in the
Switch2:Path2 branch. The pseudo code shows this logic.

model='rtwdemo_condinput';
open_system(model);
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Generate Code

The Conditional input branch execution parameter is on by default. Enter the following command-
line API to turn off the parameter.

set_param(model, 'ConditionallyExecuteInputs', 'off');

Create a temporary folder for the build and inspection process.

currentDir=pwd;
[~,cgDir]=rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_condinput
### Successful completion of build procedure for: rtwdemo_condinput

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                                    
==================================================================================================
rtwdemo_condinput  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.251s

View the generated code without the optimization. These lines of code are in the
rtwdemo_condinput.c file.

cfile = fullfile(cgDir,'rtwdemo_condinput_grt_rtw','rtwdemo_condinput.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_condinput_step(void)
{
  /* Switch: '<Root>/ Switch2' incorporates:
   *  Constant: '<Root>/C_5'
   *  Inport: '<Root>/input'
   *  RelationalOperator: '<Root>/Relational Operator'
   */
  if (rtwdemo_condinput_U.input >= -5.0) {
    /* Switch: '<Root>/Switch1' incorporates:
     *  Gain: '<Root>/  G3'
     */
    rtwdemo_condinput_Y.output = 3.0 * rtwdemo_condinput_U.input;
  } else {
    /* Switch: '<Root>/Switch1' incorporates:
     *  Constant: '<Root>/ C_10'
     *  Sum: '<Root>/ Sum'
     */
    rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + -10.0;
  }

  /* End of Switch: '<Root>/ Switch2' */
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  /* Switch: '<Root>/Switch1' incorporates:
   *  Constant: '<Root>/C5'
   *  Inport: '<Root>/input'
   *  RelationalOperator: '<Root>/Relational Operator1'
   */
  if (rtwdemo_condinput_U.input >= 5.0) {
    /* Switch: '<Root>/Switch1' incorporates:
     *  Constant: '<Root>/  C10'
     *  Outport: '<Root>/output'
     *  Sum: '<Root>/ Sum1'
     */
    rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + 10.0;
  }

  /* End of Switch: '<Root>/Switch1' */
}

The generated code contains an if-else statement for the Switch2 block and an if statement for
the Switch1 block. Therefore, the generated code for Switch1:Path2 executes even if the if
statement for Switch1:Path1 evaluates to true.

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 Select the Conditional input branch execution parameter. Alternatively, you can use the

command-line API to enable the optimization.

set_param(model, 'ConditionallyExecuteInputs','on');

Generate Code with Optimization

slbuild(model)
cfile = fullfile(cgDir,'rtwdemo_condinput_grt_rtw','rtwdemo_condinput.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

### Starting build procedure for: rtwdemo_condinput
### Successful completion of build procedure for: rtwdemo_condinput

Build Summary

Top model targets built:

Model              Action                       Rebuild Reason                   
=================================================================================
rtwdemo_condinput  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.798s

/* Model step function */
void rtwdemo_condinput_step(void)
{
  /* Switch: '<Root>/Switch1' incorporates:
   *  Constant: '<Root>/C5'
   *  Constant: '<Root>/C_5'
   *  Inport: '<Root>/input'
   *  RelationalOperator: '<Root>/Relational Operator'
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   *  RelationalOperator: '<Root>/Relational Operator1'
   *  Switch: '<Root>/ Switch2'
   */
  if (rtwdemo_condinput_U.input >= 5.0) {
    /* Outport: '<Root>/output' incorporates:
     *  Constant: '<Root>/  C10'
     *  Sum: '<Root>/ Sum1'
     */
    rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + 10.0;
  } else if (rtwdemo_condinput_U.input >= -5.0) {
    /* Switch: '<Root>/ Switch2' incorporates:
     *  Gain: '<Root>/  G3'
     *  Outport: '<Root>/output'
     */
    rtwdemo_condinput_Y.output = 3.0 * rtwdemo_condinput_U.input;
  } else {
    /* Outport: '<Root>/output' incorporates:
     *  Constant: '<Root>/ C_10'
     *  Sum: '<Root>/ Sum'
     *  Switch: '<Root>/ Switch2'
     */
    rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + -10.0;
  }

  /* End of Switch: '<Root>/Switch1' */
}

The generated code contains one if statement. The generated code for Switch1:Path2 only
executes if the if statement evaluates to false.

Close Model and Code Generation Report

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Conditional input branch execution” | Multiport Switch | Switch

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Eliminate Dead Code Paths in Generated Code” on page 69-55

69 Optimizations for Generated Code in Simulink Coder

69-64



Optimize Generated Code for Complex Signals
This example shows how Simulink Coder handles complex signals efficiently. To view the data types of
the signals, update the model. On the Debug menu, select Update Model. Complex signals are
represented as structures in generated code. Simulink Coder performs various optimizations on these
structures. For example:

• Expression Folding: Gain and Sum operations on the complex signal are folded into a single
expression.

• For-loop fusion: Two separate for-loops, one for the complex signal and one for noncomplex signal,
are combined into a single for-loop.

• Inlined block parameters: The value of Gain block "pi" is inlined in the expression of the complex
Gain-Sum.

Because of optimizations such as these, the code generated for complex and noncomplex signals is
equally efficient.

Example Model

model='rtwdemo_complex';
open_system(model);

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
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• “Disable Nonfinite Checks or Inlining for Math Functions” on page 69-26
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Speed Up Linear Algebra in Code Generated from a MATLAB
Function Block

To improve the execution speed of code generated for certain linear algebra functions in a MATLAB
Function block, specify that the code generator produce LAPACK calls. LAPACK is a software library
for numerical linear algebra. The code generator uses the LAPACKE C interface to LAPACK. If you
specify that you want to generate LAPACK calls, and the input arrays for the linear algebra functions
meet certain criteria, the code generator produces the LAPACK calls. Otherwise, the code generator
produces code for the linear algebra functions.

The code generator uses the LAPACK library that you specify. Specify a LAPACK library that is
optimized for your execution environment. See www.netlib.org/lapack/
faq.html#_what_and_where_are_the_lapack_vendors_implementations.

Specify LAPACK Library
To generate LAPACK calls, you must have access to a LAPACK callback class. A LAPACK callback
class specifies the LAPACK library and LAPACKE header file for the LAPACK calls. To indicate that
you want to generate LAPACK calls and that you want to use a specific LAPACK library, specify the
name of the LAPACK callback class. In the Configuration Parameters dialog box, set Custom
LAPACK library callback to the name of the callback class, for example, useMyLAPACK.

Write LAPACK Callback Class
To specify the locations of a particular LAPACK library and LAPACKE header file, write a LAPACK
callback class. Share the callback class with others who want to use this LAPACK library for LAPACK
calls in generated code.

The callback class must derive from the abstract class coder.LAPACKCallback. Use this example
callback class as a template.

classdef useMyLAPACK < coder.LAPACKCallback
    methods (Static)
        function hn = getHeaderFilename()
            hn = 'mylapacke_custom.h';
        end
        function updateBuildInfo(buildInfo, buildctx)
            buildInfo.addIncludePaths(fullfile(pwd,'include'));
            libName = 'mylapack';
            libPath = fullfile(pwd,'lib');
            [~,linkLibExt] = buildctx.getStdLibInfo();
            buildInfo.addLinkObjects([libName linkLibExt], libPath, ...
                '', true, true);
            buildInfo.addDefines('HAVE_LAPACK_CONFIG_H');
            buildInfo.addDefines('LAPACK_COMPLEX_STRUCTURE');
            buildInfo.addDefines('LAPACK_ILP64'); 
        end
    end
end

You must provide the getHeaderFilename and updateBuildInfo methods. The
getHeaderFilename method returns the LAPACKE header file name. In the example callback class,
replace mylapacke_custom.h with the name of your LAPACKE header file. The updateBuildInfo
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method provides the information required for the build process to link to the LAPACK library. Use
code like the code in the template to specify the location of header files and the full path name of the
LAPACK library. In the example callback class, replace mylapack with the name of your LAPACK
library.

If your compiler supports only complex data types that are represented as structures, include these
lines in the updateBuildInfo method.

buildInfo.addDefines('HAVE_LAPACK_CONFIG_H');
buildInfo.addDefines('LAPACK_COMPLEX_STRUCTURE');

You must specify the integer type that your LAPACK library uses. Not specifying this integer type can
result in incorrect behaviors or crashes. Do one of the following:

• Include these lines in the updateBuildInfo method.

buildInfo.addDefines('HAVE_LAPACK_CONFIG_H');
buildInfo.addDefines('LAPACK_ILP64');

• Alternatively, you can directly specify the integer type that your LAPACK library uses. For
example, if the integer type is long long, include this line in the updateBuildInfo method.

buildInfo.addDefines('lapack_int=long long');

Generate LAPACK Calls by Specifying a LAPACK Callback Class
This example shows how to generate code that calls LAPACK functions in a specific LAPACK library.
For this example, assume that the LAPACK callback class useMyLAPACK specifies the LAPACK library
that you want.

1 Create a Simulink model.
2 Add a MATLAB Function block to the model.
3 In the MATLAB Function block, add code that calls a linear algebra function. For example, add

the function mysvd that calls the MATLAB function svd.

function s = mysvd(A)
    %#codegen
    s = svd(A);
end

4 Add a Constant block to the left of the MATLAB Function block. Set the value to zeros(500).
5 Add an Outport block to the right of the MATLAB Function block.
6 Connect the blocks.

7 Set the Configuration Parameters > Code Generation > Advanced parameters > Custom
LAPACK library callback parameter to useMyLAPACK.

The callback class must be on the MATLAB path.
8 Build the model.
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If the input to mysvd is large enough, the code generator produces a LAPACK call for svd. An
example of a call to the LAPACK library function for svd is:

info_t = LAPACKE_dgesvd( ...
     LAPACK_COL_MAJOR, 'N', 'N', (lapack_int)500, ...
     (lapack_int)500, &A[0], (lapack_int)500, &S[0], ...
     NULL, (lapack_int)1, NULL,(lapack_int)1, &superb[0]);

Locate LAPACK Library in Execution Environment
The LAPACK library must be available in your execution environment. If your LAPACK library is
shared, use environment variables or linker options to specify the location of the LAPACK library.

• On a Windows platform, modify the PATH environment variable.
• On a Linux platform, modify the LD_LIBRARY_PATH environment variable or use the rpath linker

option.
• On a macOS platform, modify the DYLD_LIBRARY_PATH environment variable or use the rpath

linker option.

To specify the rpath linker option, you can use the build information addLinkFlags method in the
updateBuildInfo method of your coder.LAPACKCallback class. For example, for a GCC
compiler:

buildInfo.addLinkFlags(sprintf('-Wl,-rpath,"%s"',libPath));

See Also
coder.LAPACKCallback

More About
• “LAPACK Calls for Linear Algebra in a MATLAB Function Block”

External Websites
• www.netlib.org/lapack
• www.netlib.org/lapack/faq.html#_what_and_where_are_the_lapack_vendors_implementations
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Speed Up Matrix Operations in Code Generated from a MATLAB
Function Block

To improve the execution speed of code generated for certain low-level vector and matrix operations
(such as matrix multiplication) in a MATLAB Function block, specify that you want the code generator
to produce BLAS calls. BLAS is a software library for low-level vector and matrix computations that
has several highly optimized machine-specific implementations. The code generator uses the CBLAS
C interface to BLAS. If you specify that you want to generate BLAS calls, and the input arrays for the
matrix functions meet certain criteria, the code generator produces the BLAS calls. Otherwise, the
code generator produces code for the matrix functions.

The code generator uses the BLAS library that you specify. Specify a BLAS library that is optimized
for your execution environment.

Specify BLAS Library
To produce BLAS calls in generated code, you must have access to a BLAS callback class. A BLAS
callback class specifies the BLAS library, the CBLAS header file, certain C data types the particular
CBLAS interface uses and the compiler and linker options for the build process.

To indicate that you want to generate BLAS calls and use a specific BLAS library, specify the name of
the BLAS callback class. In the Configuration Parameters dialog box, set Custom BLAS library
callback to the name of the callback class.

Write BLAS Callback Class
To generate calls to a specific BLAS library in the generated code, write a BLAS callback class. Share
the callback class with others who want to use this BLAS library for BLAS calls in standalone code.

The callback class must derive from the abstract class coder.BLASCallback. This example is an
implementation of the callback class mklcallback for integration with the Intel MKL BLAS library
on a Windows platform.

classdef mklcallback < coder.BLASCallback
    methods (Static)
        function updateBuildInfo(buildInfo, ~)
            libPath = fullfile(pwd,'mkl','WIN','lib','intel64');
            libPriority = '';
            libPreCompiled = true;
            libLinkOnly = true;
            libs = {'mkl_intel_ilp64.lib' 'mkl_intel_thread.lib' 'mkl_core.lib'};
            buildInfo.addLinkObjects(libs, libPath, libPriority, libPreCompiled, ...
                                  libLinkOnly);
            buildInfo.addLinkObjects('libiomp5md.lib',fullfile(matlabroot,'bin', ...
                             'win64'), libPriority, libPreCompiled, libLinkOnly);
            buildInfo.addIncludePaths(fullfile(pwd,'mkl','WIN','include'));
            buildInfo.addDefines('-DMKL_ILP64');
        end
        function headerName = getHeaderFilename()
            headerName = 'mkl_cblas.h';
        end
        function intTypeName = getBLASIntTypeName()
            intTypeName = 'MKL_INT';
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        end
    end
end

You must provide the getHeaderFilename, getBLASIntTypeName, and updateBuildInfo
methods. The getHeaderFilename method returns the CBLAS header file name. If you are using a
different BLAS library, replace mkl_cblas.h with the name of your CBLAS header file. The
getBLASIntTypeName method returns the name of the integer data type that your CBLAS interface
uses. If you are using a different BLAS library, replace MKL_INT with the name of the integer data
type specific to your CBLAS interface. The updateBuildInfo method provides the information
required for the build process to link to the BLAS library. Use code that is like the code in the
example callback class to specify the location of header file, the full path name of the BLAS library,
and the compiler and linker options. If you use the Intel MKL BLAS library, use the link line advisor to
see which libraries and compiler options are recommended for your use case.

There are three other methods that are already implemented in coder.BLASCallback. These
methods are getBLASDoubleComplexTypeName, getBLASSingleComplexTypeName, and
useEnumNameRatherThanTypedef. By default, your callback class inherits these implementations
from coder.BLASCallback. In certain situations, you must override these methods with your own
definitions when you define your callback class.

The getBLASDoubleComplexTypeName method returns the type used for double-precision complex
variables in the generated code. If your BLAS library takes a type other than double* and void* for
double-precision complex array arguments, include this method in your callback class definition.

function doubleComplexTypeName = getBLASDoubleComplexTypeName()
doubleComplexTypeName = 'my_double_complex_type';
end

Replace my_double_complex_type with the type that your BLAS library takes for double-precision
complex array arguments.

The getBLASSingleComplexTypeName method returns the type used for single-precision complex
variables in the generated code. If your BLAS library takes a type other than float* and void* for
single-precision complex array arguments, include this method in your callback class definition.

function singleComplexTypeName = getBLASSingleComplexTypeName()
doubleComplexTypeName = 'my_single_complex_type';
end

Replace my_single_complex_type with the type that your BLAS library takes for single-precision
complex array arguments.

The useEnumNameRatherThanTypedef method returns false by default. If types for enumerations
in your BLAS library include the enum keyword, redefine this method to return true in your callback
class definition.

function p = useEnumNameRatherThanTypedef()
p = true;
end

An excerpt from generated C source code that includes the enum keyword is:

enum CBLAS_SIDE t;
enum CBLAS_UPLO b_t;
double temp;
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enum CBLAS_TRANSPOSE c_t;
enum CBLAS_DIAG d_t;

Generate BLAS Calls by Specifying a BLAS Callback Class
This example shows how to generate code that calls BLAS functions in a specific BLAS library. The
BLAS callback class useMyBLAS specifies the BLAS library that you want to use in this example.

1 Create a Simulink model.
2 Add a MATLAB Function block to the model.
3 In the MATLAB Function block, add code that calls a function for a basic matrix operation. For

example, add the function myMultiply that multiplies two matrices A and B.

function C = myMultiply(A,B) %#codegen
C = A*B;
end

4 Add two Constant blocks to the left of the MATLAB Function block. Set their values to
zeros(1000).

5 Add an Outport block to the right of the MATLAB Function block.
6 Connect the blocks.

7 In the Configuration Parameters dialog box, set Custom BLAS library callback to the name of
the callback class useMyBLAS.

The callback class must be on the MATLAB path.
8 Build the model.

If A and B are large enough, the code generator produces a BLAS call for the matrix
multiplication function.

Locate BLAS Library in Execution Environment
The BLAS library must be available in your execution environment. If your BLAS library is shared, use
environment variables or linker options to specify the location of the BLAS library.

• On a Windows platform, modify the PATH environment variable.
• On a Linux platform, modify the LD_LIBRARY_PATH environment variable or use the rpath linker

option.
• On a macOS platform, modify the DYLD_LIBRARY_PATH environment variable or use the rpath

linker option.

To specify the rpath linker option, use the build information addLinkFlags method in the
updateBuildInfo method of your BLAS callback class. For example, for a GCC compiler:

buildInfo.addLinkFlags(sprintf('-Wl,-rpath,"%s"',libPath));
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Usage Notes and Limitations for OpenBLAS Library
If you generate code that includes calls to the OpenBLAS library functions, follow these guidelines
and restrictions:

• If you generate C++ code that includes calls to OpenBLAS library functions, compiling it with the
-pedantic option produces warnings. To disable the -pedantic compiler option, include these
lines in the updateBuildInfo method:

if ctx.getTargetLang() == 'C++'
    buildInfo.addCompileFlags('-Wno-pedantic');
end

• OpenBLAS does not support the C89/C90 standard.

See Also
coder.BLASCallback

More About
• “BLAS Calls for Matrix Operations in a MATLAB Function Block”

External Websites
• https://www.netlib.org/blas/
• https://www.netlib.org/blas/

faq.html#_5_a_id_are_optimized_blas_libraries_available_where_can_i_find_vendor_supplied_bla
s_a_are_optimized_blas_libraries_available_where_can_i_find_optimized_blas_libraries

• https://software.intel.com/content/www/us/en/develop/documentation/mkl-developer-reference-
c/top/blas-and-sparse-blas-routines.html

• https://software.intel.com/content/www/us/en/develop/articles/intel-mkl-link-line-advisor.html
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Speed Up Fast Fourier Transforms in Code Generated from a
MATLAB Function Block

This example shows how to generate calls to a specific installed FFTW library. For more information
about FFTW, see www.fftw.org.

When you simulate a model that includes a MATLAB Function block that calls MATLAB fast Fourier
transform (FFT) functions, the simulation software uses the library that MATLAB uses for FFT
algorithms. If you generate C/C++ code for this model, by default, the code generator produces code
for the FFT algorithms instead of producing FFT library calls. To increase the speed of fast Fourier
transforms in generated code, specify that the code generator produce calls to a specific installed
FFTW library.

The code generator produces FFTW library calls when all of these conditions are true:

• A MATLAB Function block calls one of these MATLAB functions:fft, fft2, fftn, ifft, ifft2, or
ifftn.

• You generate C/C++ code from a model that includes the MATLAB Function block.
• You have access to an FFTW library installation, version 3.2 or later.
• You specify the FFTW library installation in an FFT library callback class that derives from

coder.fftw.StandaloneFFTW3Interface.
• You set the Custom FFT library callback configuration parameter to the name of the callback

class.

Install an FFTW Library
If you do not have access to an installed FFTW library, version 3.2 or later, then you must install one.

For a Linux platform or a Mac platform, consider using a package manager to install the FFTW
library.

For a Windows platform, in addition to .dll files, you must have .lib import libraries, as described
in the Windows installation notes on the FFTW website.

See the installation instructions for your platform on the FFTW website.

Write FFT Callback Class
To specify your installation of the FFTW library, write an FFT callback class. Share the callback class
with others who want to use this FFTW library for FFTW calls.

The callback class must derive from the abstract class coder.fftw.StandaloneFFTW3Interface.
Use this example callback class as a template.

% copyright 2017 The MathWorks, Inc.

classdef useMyFFTW < coder.fftw.StandaloneFFTW3Interface
     
    methods (Static)
        function th = getNumThreads
            coder.inline('always');
            th = int32(coder.const(1));
        end
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        function updateBuildInfo(buildInfo, ctx)
            fftwLocation = '/usr/lib/fftw';
            includePath = fullfile(fftwLocation, 'include');
            buildInfo.addIncludePaths(includePath);
            libPath = fullfile(fftwLocation, 'lib');
            
            %Double
            libName1 = 'libfftw3-3';
            [~, libExt] = ctx.getStdLibInfo();
            libName1 = [libName1 libExt];
            addLinkObjects(buildInfo, libName1, libPath, 1000, true, true);
            
            %Single
             libName2 = 'libfftw3f-3';
            [~, libExt] = ctx.getStdLibInfo();
            libName2 = [libName2 libExt];
            addLinkObjects(buildInfo, libName2, libPath, 1000, true, true);
        end
    end           
end

Implement the updateBuildInfo and getNumThreads methods. In the updateBuildInfo
method, set fftwLocation to the full path for your installation of the library. Set includePath to
the full path of the folder that contains fftw3.h. Set libPath to the full path of the folder that
contains the library files. If your FFTW installation uses multiple threads, modify the
getNumThreads method to return the number of threads that you want to use.

Optionally, you can implement these methods:

• getPlanMethod to specify the FFTW planning method. See
coder.fftw.StandaloneFFTW3Interface.

• lock and unlock to synchronize multithreaded access to the FFTW planning process. See
“Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block”.

Generate FFTW Calls by Specifying an FFT Callback Class
1 Create a Simulink model.
2 Add a MATLAB Function block to the model.
3 In the MATLAB Function block, add code that calls a MATLAB FFT function. For example, add

the function myfft that calls the MATLAB function fft.

function y = myfft()
t = 0:1/50:10-1/50;
x = sin(2*pi*15*t) + sin(2*pi*20*t);
y = fft(x);
end

4 Connect the blocks.

5 Indicate that the code generator produce calls to the FFTW library specified in the FFT library
callback class useMyFFTW. In the Configuration Parameters dialog box, set Custom FFT library
callback to useMyFFTW.

The callback class must be on the MATLAB path.
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6 Build the model.

Locate FFTW Library in Execution Environment

The FFTW library must be available in your execution environment. If the FFTW library is shared, use
environment variables or linker options to specify the location of the library.

• On a Windows platform, modify the PATH environment variable.
• On a Linux platform, modify the LD_LIBRARY_PATH environment variable or use the rpath linker

option.
• On a macOS platform, modify the DYLD_LIBRARY_PATH environment variable or use the rpath

linker option.

To specify the rpath linker option, you can use the build information addLinkFlags method in the
updateBuildInfo method of your coder.fftw.StandaloneFFTW3Interface class. For example,
for a GCC compiler:

buildInfo.addLinkFlags(sprintf('-Wl,-rpath,"%s"',libPath));

See Also
coder.fftw.StandaloneFFTW3Interface

More About
• “Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block”

External Websites
• www.fftw.org
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Synchronize Multithreaded FFTW Planning in Code Generated
from a MATLAB Function Block

This example shows how to generate code that synchronizes multithreaded access to the FFTW
planning process for FFTW library calls in code generated from a MATLAB Function block.

The code generator produces FFTW library calls when all of these conditions are true:

• A MATLAB Function block calls one of these functions:fft, fft2, fftn, ifft, ifft2, or ifftn.
• You generate C/C++ code for a model that includes the MATLAB Function block.
• You have access to an FFTW library installation, version 3.2 or later.
• You specify the FFTW library installation in an FFT library callback class that derives from

coder.fftw.StandaloneFFTW3Interface.
• You set the Custom FFT library callback configuration parameter to the name of the callback

class.

If you integrate the code that contains the FFTW calls with external code that runs on multiple
threads, then you must prevent concurrent access to the FFTW planning process. In your FFT library
callback class, implement the lock and unlock methods. You must also provide C code that manages
a lock or mutex. Many libraries, such as OpenMP, pthreads, and the C++ standard library (C++ 11
and later), provide locks. This example shows how to implement the lock and unlock methods and
provide supporting C code. To manage a lock, this example uses the OpenMP library.

Prerequisites
Before you start, for the basic workflow for generating FFTW library calls for fast Fourier transforms
in a MATLAB Function block, see “Speed Up Fast Fourier Transforms in Code Generated from a
MATLAB Function Block”.

You must have:

• Access to an installed FFTW library.
• A compiler that supports the OpenMP library. To use a different library, such as pthreads, modify

the supporting C code accordingly.

Create a Model with a MATLAB Function Block That Calls an FFT
Function
1 Create a Simulink model and add a MATLAB Function block to it.
2 Add this code to the MATLAB Function block.

function y  = mycustomfft()

t = 0:1/50:10-1/50;
x = sin(2*pi*15*t) + sin(2*pi*20*t);
y = fft(x);
for k = 1:100
    y = y + ifft(x+k);
end
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3 Add an outport block and connect it to the MATLAB Function block.

Write Supporting C Code
Write C functions that initialize, set, and unset a lock. This example uses the OpenMP library to
manage the lock. For a different library, modify the code accordingly.

• Create a file mylock.c that contains this C code:

#include "mylock.h"
#include "omp.h"

static omp_nest_lock_t lockVar;

void mylock_initialize(void)
{
    omp_init_nest_lock(&lockVar);
}

void mylock(void)
{
    omp_set_nest_lock(&lockVar);
}

void myunlock(void)
{
    omp_unset_nest_lock(&lockVar);
}  

• Create a header file mylock.h that contains:

#ifndef MYLOCK_H
#define MYLOCK_H

 void mylock_initialize(void);
 void mylock(void);
 void myunlock(void);

#endif

Create an FFT Library Callback Class
Write an FFT callback class myfftcb that:

• Specifies the FFTW library.
• Implements lock and unlock methods that call the supporting C code to control access to the

FFTW planning.
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Use this class as a template. Replace fftwLocation with the location of your FFTW library
installation.

classdef myfftcb < coder.fftw.StandaloneFFTW3Interface
    
    methods (Static)
        function th = getNumThreads
            coder.inline('always');
            th = int32(coder.const(1));
        end
        
        function lock()
            coder.cinclude('mylock.h', 'InAllSourceFiles', true);
            coder.inline('always');
            coder.ceval('mylock');
        end
        
        function unlock()
            coder.cinclude('mylock.h', 'InAllSourceFiles', true);
            coder.inline('always');
            coder.ceval('myunlock');
        end
        
        function updateBuildInfo(buildInfo, ctx)
            fftwLocation = '\usr\lib\fftw';
            includePath = fullfile(fftwLocation, 'include');
            buildInfo.addIncludePaths(includePath);
            libPath = fullfile(fftwLocation, 'lib');
            
            %Double
            libName1 = 'libfftw3-3';
            [~, libExt] = ctx.getStdLibInfo();
            libName1 = [libName1 libExt];
            addLinkObjects(buildInfo, libName1, libPath, 1000, true, true);
            
            %Single
            libName2 = 'libfftw3f-3';
            [~, libExt] = ctx.getStdLibInfo();
            libName2 = [libName2 libExt];
            addLinkObjects(buildInfo, libName2, libPath, 1000, true, true);
            
        end
    end
end

Configure Code Generation Parameters and Build the Model
1 Configure code generation to use the FFTW callback class and the C code called by the lock and

unlock methods. Configure code generation to generate a call to mylock_initialize in the
initialization code.

In the Configuration Parameters dialog box:

• Set Custom FFT library callback to myfftcb.
• In Code Generation > Custom Code, under Additional build information, set Source
files to mylock.c.
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• In Code Generation > Custom Code, under Insert custom C code in generated, set
Initialize function to mylock_initialize();.

2 Build the model.

See Also
coder.fftw.StandaloneFFTW3Interface

More About
• “Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block”

External Websites
• www.fftw.org
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Control Memory Allocation for Variable-Size Arrays in a
MATLAB Function Block

Dynamic memory allocation allocates memory on the heap as needed at run time, instead of
allocating memory statically on the stack. You can use dynamic memory allocation for arrays inside a
MATLAB Function block.

You cannot use dynamic memory allocation for:

• Input and output signals. Variable-size input and output signals must have an upper bound.
• Parameters or global variables. Parameters and global variables must be fixed-size.
• Fields of bus arrays. Bus arrays cannot have variable-size fields.
• Discrete state properties of System objects associated with a MATLAB System block.

Dynamic memory allocation is beneficial when:

• You do not know the upper bound of an array.
• You do not want to allocate memory on the stack for large arrays.

Dynamic memory allocation and the freeing of this memory can result in slower execution of the
generated code. To control the use of dynamic memory allocation for variable-size arrays in a
MATLAB Function block, you can:

• Provide upper bounds for variable-size arrays on page 69-81.
• Disable dynamic memory allocation for MATLAB Function blocks on page 69-81.
• Modify the dynamic memory allocation threshold on page 69-81.

Provide Upper Bounds for Variable-Size Arrays
For an unbounded variable-size array, the code generator allocates memory dynamically on the heap.
For a bounded variable-size array, if the size, in bytes, is less than the dynamic memory allocation
threshold, the code generator allocates memory statically on the stack. To avoid dynamic memory
allocation, provide upper bounds for the array dimensions so that the size of the array, in bytes, is
less than the dynamic memory allocation threshold. See “Specify Upper Bounds for Variable-Size
Arrays”.

Disable Dynamic Memory Allocation for MATLAB Function Blocks
By default, dynamic memory allocation for MATLAB Function blocks is enabled for GRT-based targets
and disabled for ERT-based targets. To change the setting, in the Configuration Parameters dialog
box, clear or select Dynamic memory allocation in MATLAB functions.

If you disable dynamic memory allocation, you must provide upper bounds for variable-size arrays.

Modify the Dynamic Memory Allocation Threshold
Instead of disabling dynamic memory allocation for all variable-size arrays, you can use the dynamic
memory allocation threshold to specify when the code generator uses dynamic memory allocation.

Use the dynamic memory allocation threshold to:
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• Disable dynamic memory allocation for smaller arrays. For smaller arrays, static memory
allocation can speed up generated code. However, static memory allocation can lead to unused
storage space. You can decide that the unused storage space is not a significant consideration for
smaller arrays.

• Enable dynamic memory allocation for larger arrays. For larger arrays, when you use dynamic
memory allocation, you can significantly reduce storage requirements.

The default value of the dynamic memory allocation threshold is 64 kilobytes. To change the
threshold, in the Configuration Parameters dialog box, set the Dynamic memory allocation
threshold in MATLAB functions parameter.

To use dynamic memory allocation for all variable-size arrays, set the threshold to 0.

See Also

More About
• “Code Generation for Variable-Size Arrays”
• “Specify Upper Bounds for Variable-Size Arrays”
• “Use Dynamic Memory Allocation for Variable-Size Arrays in a MATLAB Function Block”
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Optimize Memory Usage for Time Counters
This example shows how to optimize the amount of memory that the code generator allocates for time
counters. The example optimizes the memory that stores elapsed time, the interval of time between
two events.

The code generator represents time counters as unsigned integers. The word size of time counters is
based on the setting of the model configuration parameter Application lifespan (days), which
specifies the expected maximum duration of time the application runs. You can use this parameter to
prevent time counter overflows. The default size is 64 bits.

The number of bits that a time counter uses depends on the setting of the Application lifespan
(days) parameter. For example, if a time counter increments at a rate of 1 kHz, to avoid an overflow,
the counter has the following number of bits:

• Lifespan < 0.25 sec: 8 bits
• Lifespan < 1 min: 16 bits
• Lifespan < 49 days: 32 bits
• Lifespan > 50 days: 64 bits

A 64-bit time counter does not overflow for 590 million years.

Open Example Model

Open the example model rtwdemo_abstime.
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The model consists of three subsystems SS1, SS2, and SS3. On the Math and Data Types pane, the
Application lifespan (days) parameter is set to the default, which is inf.

The three subsystems contain a discrete-time integrator that requires elapsed time as input to
compute its output value. The subsystems vary as follows:

• SS1 - Clocked at 1 kHz. Does not require a time counter. Sample time type parameter for trigger
port is set to periodic. Elapsed time is inlined as 0.001.

• SS2 - Clocked at 100 Hz. Requires a time counter. Based on a lifespan of 1 day, a 32-bit counter
stores the elapsed time.

• SS3 - Clocked at 0.5 Hz. Requires a time counter. Based on a lifespan of 1 day, a 16-bit counter
stores the elapsed time.

Simulate the Model

Simulate the model. By default, the model is configured to show sample times in different colors.
Discrete sample times for the three subsystems appear red, green, and blue. Triggered subsystems
are blue-green.

Generate Code and Report

1. Create a temporary folder for the build and inspection process.

2. Configure the model for the code generator to use the GRT system target file and a lifespan of inf
days.

3. Build the model.

### Starting build procedure for: rtwdemo_abstime
### Successful completion of build procedure for: rtwdemo_abstime

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                                    
================================================================================================
rtwdemo_abstime  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.681s

Review Generated Code

Open the generated source file rtwdemo_abstime.c.

struct tag_RTM_rtwdemo_abstime_T {
  const char_T *errorStatus;

  /*
   * Timing:
   * The following substructure contains information regarding
   * the timing information for the model.
   */
  struct {
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    uint32_T clockTick1;
    uint32_T clockTickH1;
    uint32_T clockTick2;
    uint32_T clockTickH2;
    struct {
      uint16_T TID[3];
      uint16_T cLimit[3];
    } TaskCounters;
  } Timing;
};

/* Block states (default storage) */
extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

/* Zero-crossing (trigger) state */
extern PrevZCX_rtwdemo_abstime_T rtwdemo_abstime_PrevZCX;

/* External inputs (root inport signals with default storage) */
extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

/* External outputs (root outports fed by signals with default storage) */
extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;

/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step0(void);
extern void rtwdemo_abstime_step1(void);
extern void rtwdemo_abstime_step2(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*-
 * The generated code includes comments that allow you to trace directly
 * back to the appropriate location in the model.  The basic format
 * is <system>/block_name, where system is the system number (uniquely
 * assigned by Simulink) and block_name is the name of the block.
 *
 * Use the MATLAB hilite_system command to trace the generated code back
 * to the model.  For example,
 *
 * hilite_system('<S3>')    - opens system 3
 * hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3
 *
 * Here is the system hierarchy for this model
 *
 * '<Root>' : 'rtwdemo_abstime'
 * '<S1>'   : 'rtwdemo_abstime/SS1'
 * '<S2>'   : 'rtwdemo_abstime/SS2'
 * '<S3>'   : 'rtwdemo_abstime/SS3'
 */
#endif                                 /* RTW_HEADER_rtwdemo_abstime_h_ */

Four 32-bit unsigned integers, clockTick1 , clockTickH1 , clockTick2 , and clockTickH2 are
counters for storing the elapsed time of subsystems SS2 and SS3.
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Enable Optimization and Regenerate Code

1. Reconfigure the model to set the lifespan to 1 day.

2. Build the model.

### Starting build procedure for: rtwdemo_abstime
### Successful completion of build procedure for: rtwdemo_abstime

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                     
=================================================================================
rtwdemo_abstime  Code generated and compiled  Incremental checksum has changed.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.185s

Review the Regenerated Code

struct tag_RTM_rtwdemo_abstime_T {
  const char_T *errorStatus;

  /*
   * Timing:
   * The following substructure contains information regarding
   * the timing information for the model.
   */
  struct {
    uint32_T clockTick1;
    uint16_T clockTick2;
    struct {
      uint16_T TID[3];
      uint16_T cLimit[3];
    } TaskCounters;
  } Timing;
};

/* Block states (default storage) */
extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

/* Zero-crossing (trigger) state */
extern PrevZCX_rtwdemo_abstime_T rtwdemo_abstime_PrevZCX;

/* External inputs (root inport signals with default storage) */
extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

/* External outputs (root outports fed by signals with default storage) */
extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;

/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step0(void);
extern void rtwdemo_abstime_step1(void);
extern void rtwdemo_abstime_step2(void);
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extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*-
 * The generated code includes comments that allow you to trace directly
 * back to the appropriate location in the model.  The basic format
 * is <system>/block_name, where system is the system number (uniquely
 * assigned by Simulink) and block_name is the name of the block.
 *
 * Use the MATLAB hilite_system command to trace the generated code back
 * to the model.  For example,
 *
 * hilite_system('<S3>')    - opens system 3
 * hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3
 *
 * Here is the system hierarchy for this model
 *
 * '<Root>' : 'rtwdemo_abstime'
 * '<S1>'   : 'rtwdemo_abstime/SS1'
 * '<S2>'   : 'rtwdemo_abstime/SS2'
 * '<S3>'   : 'rtwdemo_abstime/SS3'
 */
#endif                                 /* RTW_HEADER_rtwdemo_abstime_h_ */

The new setting for the Application lifespan (days) parameter instructs the code generator to set
aside less memory for the time counters. The regenerated code includes:

• 32-bit unsigned integer, clockTick1, for storing the elapsed time of the task for SS2
• 16-bit unsigned integer, clockTick2, for storing the elapsed time of the task for SS3

Related Information

• “Model Configuration Parameters: Code Generation Optimization”
• “Timers in Asynchronous Tasks”
• “Time-Based Scheduling and Code Generation”

See Also

More About
• “Optimization Tools and Techniques” on page 69-7
• “Control Memory Allocation for Time Counters” on page 69-10
• “Access Timers Programmatically”
• “Generate Code for an Elapsed Time Counter”
• “Absolute Time Limitations”
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Optimize Generated Code Using Boolean Data for Logical
Signals

Optimize generated code by storing logical signals as Boolean data. When you select the model
configuration parameter Implement logic signals as Boolean data (vs. double), blocks that
generate logic signals output Boolean signals.

The optimization:

• Reduces the ROM and RAM consumption.
• Improves execution speed.

Example Model

Consider the model rtwdemo_logicalAsBoolean. The outputs of the Relational Operator,
Logical Operator and HitCrossing blocks are double, even though they represent logical data.

model = 'rtwdemo_logicalAsBoolean';
open_system(model);

Generate Code

Create a temporary folder (in your system temporary folder) for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.
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slbuild(model)

### Starting build procedure for: rtwdemo_logicalAsBoolean
### Successful completion of build procedure for: rtwdemo_logicalAsBoolean

Build Summary

Top model targets built:

Model                     Action                       Rebuild Reason                                    
=========================================================================================================
rtwdemo_logicalAsBoolean  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 17.31s

View the generated code without the optimization. These lines of code are in
rtwdemo_logicalAsBoolean.h.

hfile = fullfile(cgDir,'rtwdemo_logicalAsBoolean_ert_rtw',...
    'rtwdemo_logicalAsBoolean.h');
rtwdemodbtype(hfile,'/* External outputs','/* Parameters (default storage) */',1,0);

/* External outputs (root outports fed by signals with default storage) */
typedef struct {
  real_T Out1;                         /* '<Root>/Out1' */
  real_T Out2;                         /* '<Root>/Out2' */
  real_T Out3;                         /* '<Root>/Out3' */
} ExtY_rtwdemo_logicalAsBoolean_T;

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 Select the Implement logic signals as Boolean data (vs. double) parameter.

Alternatively, you can use the command-line API to enable the optimization:

set_param(model,'BooleanDataType','on');

Generate Code with Optimization

The generated code stores the logical signal output as Boolean data.

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_logicalAsBoolean
### Successful completion of build procedure for: rtwdemo_logicalAsBoolean

Build Summary

Top model targets built:

Model                     Action                       Rebuild Reason                   
========================================================================================
rtwdemo_logicalAsBoolean  Code generated and compiled  Generated code was out of date.  
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1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.667s

View the generated code with the optimization. These lines of code are in
rtwdemo_logicalAsBoolean.h.

rtwdemodbtype(hfile,'/* External outputs','/* Parameters (default storage) */',1,0);

/* External outputs (root outports fed by signals with default storage) */
typedef struct {
  boolean_T Out1;                      /* '<Root>/Out1' */
  boolean_T Out2;                      /* '<Root>/Out2' */
  boolean_T Out3;                      /* '<Root>/Out3' */
} ExtY_rtwdemo_logicalAsBoolean_T;

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Implement logic signals as Boolean data (vs. double)”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Data Types Supported by Simulink”
• “Use Conditional Input Branch Execution” on page 69-61
• “Bitfields” on page 25-68

69 Optimizations for Generated Code in Simulink Coder

69-90



Reduce Memory Usage for Boolean and State Configuration
Variables

1 Open the Model Configuration Parameters dialog box.
2 In the Model Configuration Parameters dialog box, select the Optimization pane.
3 Choose from these options:

• Use bitsets for storing state configuration — Reduces the amount of memory that stores
state configuration variables. However, it can increase the amount of memory that stores
target code if the target processor does not include instructions for manipulating bitsets.

• Use bitsets for storing Boolean data — Reduces the amount of memory that stores
Boolean variables. However, it can increase the amount of memory that stores target code if
the target processor does not include instructions for manipulating bitsets.

Note You cannot use bitsets when you generate code for these cases:

• An external mode simulation
• A target that specifies an explicit structure alignment

See Also
“Use bitsets for storing state configuration” | “Use bitsets for storing Boolean data”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Optimize Generated Code Using Boolean Data for Logical Signals” on page 69-88
• “Bitfields” on page 25-68
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Customize Stack Space Allocation
Your application might be constrained by limited memory. Controlling the maximum allowable size for
the stack is one way to modify whether data is defined as local or global in the generated code. You
can limit the use of stack space by specifying a positive integer value for the “Maximum stack size
(bytes)” parameter, on the Optimization pane of the Configuration parameter dialog box. Specifying
the maximum allowable stack size provides control over the number of local and global variables in
the generated code. Specifically, lowering the maximum stack size might generate more variables
into global structures. The number of local and global variables help determine the required amount
of stack space for execution of the generated code.

The default setting for “Maximum stack size (bytes)” is Inherit from target. In this case, the
value of the maximum stack size is the smaller value of the following: the default value set by the
code generator (200,000 bytes) or the value of the TLC variable MaxStackSize found in the system
target file (ert.tlc).

To specify a smaller stack size for your application, select the Specify a value option of the
Maximum stack size (bytes) parameter and enter a positive integer value. To specify a smaller
stack size at the command line, use:

set_param(model_name, 'MaxStackSize', 65000);

Note For overall executable stack usage metrics, you might want to do a target-specific
measurement, such as using runtime (empirical) analysis or static (code path) analysis with object
code.

It is recommended that you use the Maximum stack size (bytes) parameter to control stack space
allocation instead of modifying the TLC variable, MaxStackSize, in the system target file. However,
a target author might want to set the TLC variable, MaxStackSize, for a target. To set
MaxStackSize, use assign statements in the system target file (ert.tlc), as in the following
example.

%assign MaxStackSize = 4096

Write your %assign statements in the Configure RTW code generation settings section of
the system target file. The %assign statement is described in “Target Language Compiler”.

See Also
“Maximum stack size (bytes)”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Enable and Reuse Local Block Outputs in Generated Code” on page 69-100
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
• “Inline Numeric Values of Block Parameters” on page 69-41
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Optimize Generated Code Using memset Function
This example shows how to optimize the generated code by using the memset function to clear the
internal storage. When you select the model configuration parameter Use memset to initialize
floats and doubles to 0.0, the memset function clears internal storage, to the integer bit pattern 0
(that is, all bits are off).

If your compiler and target CPU both represent floating-point zero with the integer bit pattern 0,
consider setting this parameter to gain execution and ROM efficiency.

NOTE: The command-line values are the reverse of the settings values. 'on' in the command line
corresponds to clearing the setting. 'off' in the command line corresponds to selecting the setting.

This optimization:

• Reduces ROM consumption.
• Improves execution speed.

Example Model

Consider the model matlab:rtwdemo_memset.

model = 'rtwdemo_memset';
open_system(model);

Generate Code

The code generator uses a loop to initialize the Constant block values.

Create a temporary folder (in your system temporary folder) for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_memset
### Successful completion of build procedure for: rtwdemo_memset

Build Summary

Top model targets built:

Model           Action                       Rebuild Reason                                    
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===============================================================================================
rtwdemo_memset  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.856s

View the generated code without the optimization. These lines of code are in rtwdemo_memset.c.

cfile = fullfile(cgDir,'rtwdemo_memset_grt_rtw','rtwdemo_memset.c');
rtwdemodbtype(cfile,'/* Model initialize function */',...
    '/* Model terminate function */',1,0);

/* Model initialize function */
void rtwdemo_memset_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_memset_M, (NULL));

  /* external outputs */
  {
    int32_T i;
    for (i = 0; i < 50; i++) {
      rtwdemo_memset_Y.Out1[i] = 0.0;
    }
  }

  {
    int32_T i;

    /* ConstCode for Outport: '<Root>/Out1' */
    for (i = 0; i < 50; i++) {
      rtwdemo_memset_Y.Out1[i] = 56.0;
    }

    /* End of ConstCode for Outport: '<Root>/Out1' */
  }
}

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 In the Configuration Parameter dialog box select the Use memset to initialize floats and

doubles to 0.0 parameter. Alternatively, you can use the command-line API to enable the
optimization:

set_param(model,'InitFltsAndDblsToZero','off');

% # Open the Configuration Parameters dialog box.

Generate Code with Optimization

The code generator uses the memset function to initialize the Constant block values.

Build the model.
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slbuild(model)

### Starting build procedure for: rtwdemo_memset
### Successful completion of build procedure for: rtwdemo_memset

Build Summary

Top model targets built:

Model           Action                       Rebuild Reason                   
==============================================================================
rtwdemo_memset  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.241s

View the generated code with the optimization. These lines of code are in rtwdemo_memset.c.

rtwdemodbtype(cfile,'/* Model initialize function */',...
    '/* Model terminate function */',1,0);

/* Model initialize function */
void rtwdemo_memset_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_memset_M, (NULL));

  /* external outputs */
  (void) memset(&rtwdemo_memset_Y.Out1[0], 0,
                50U*sizeof(real_T));

  {
    int32_T i;

    /* ConstCode for Outport: '<Root>/Out1' */
    for (i = 0; i < 50; i++) {
      rtwdemo_memset_Y.Out1[i] = 56.0;
    }

    /* End of ConstCode for Outport: '<Root>/Out1' */
  }
}

Close the model and the code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Use memset to initialize floats and doubles to 0.0”
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Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 69-48
• “Vector Operation Optimization” on page 69-97
• “Remove Zero Initialization Code” on page 72-3
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Vector Operation Optimization
This example shows how Simulink® Coder™ optimizes generated code by setting block output that
generates vectors to scalars, for blocks such as the Mux, Sum, Gain, and Bus. This optimization
reduces stack memory by replacing temporary local arrays with local variables.

Example Model

In the model, rtwdemo_VectorOptimization, the output of Gain blocks G1 and G2 are the vector
signals tmp1 and tmp2. These vectors have a width of 10.

model = 'rtwdemo_VectorOptimization';
open_system(model);
set_param(model, 'SimulationCommand', 'update')

Generate Code

Create a temporary folder (in your system temporary folder) for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_VectorOptimization
### Successful completion of build procedure for: rtwdemo_VectorOptimization

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
rtwdemo_VectorOptimization  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.949s
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The optimized code is in rtwdemo_VectorOptimization.c. The signals tmp1 and tmp2 are the
local variables rtb_tmp1 and rtb_tmp2.

cfile = fullfile(cgDir,'rtwdemo_VectorOptimization_grt_rtw',...
    'rtwdemo_VectorOptimization.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_VectorOptimization_step(void)
{
  real_T rtb_Sum3;
  real_T rtb_tmp1;
  real_T rtb_tmp2;
  int32_T i;
  for (i = 0; i < 10; i++) {
    /* Gain: '<Root>/G2' incorporates:
     *  UnitDelay: '<Root>/X2'
     */
    rtb_tmp2 = 0.3 * rtwdemo_VectorOptimization_DW.X2_DSTATE[i];

    /* Gain: '<Root>/G1' incorporates:
     *  UnitDelay: '<Root>/X1'
     */
    rtb_tmp1 = 0.2 * rtwdemo_VectorOptimization_DW.X1_DSTATE[i];

    /* Sum: '<Root>/Sum3' incorporates:
     *  Gain: '<Root>/G3'
     *  Inport: '<Root>/In2'
     *  Sum: '<Root>/Sum1'
     *  Sum: '<Root>/Sum2'
     *  UnitDelay: '<Root>/X3'
     */
    rtb_Sum3 = ((rtwdemo_VectorOptimization_U.In2[i] - 0.4 *
                 rtwdemo_VectorOptimization_DW.X3_DSTATE[i]) - rtb_tmp2) -
      rtb_tmp1;

    /* Outport: '<Root>/Out2' */
    rtwdemo_VectorOptimization_Y.Out2[i] = rtb_Sum3;

    /* Update for UnitDelay: '<Root>/X3' */
    rtwdemo_VectorOptimization_DW.X3_DSTATE[i] = rtb_tmp2;

    /* Update for UnitDelay: '<Root>/X2' */
    rtwdemo_VectorOptimization_DW.X2_DSTATE[i] = rtb_tmp1;

    /* Update for UnitDelay: '<Root>/X1' */
    rtwdemo_VectorOptimization_DW.X1_DSTATE[i] = rtb_Sum3;
  }
}

Close the model and code generation report.
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bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
• “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 69-48
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Enable and Reuse Local Block Outputs in Generated Code
In this section...
“Example Model” on page 69-100
“Generate Code Without Optimization” on page 69-100
“Enable Local Block Outputs and Generate Code” on page 69-101
“Reuse Local Block Outputs and Generate Code” on page 69-102

This example shows how to specify block output as local variables. The code generator can potentially
reuse these local variables in the generated code. Declaring block output as local variables conserves
ROM consumption. Reusing local variables conserves RAM consumption, reduces data copies, and
increases execution speed.

Example Model
1 Use Inport, Outport, Gain, and Switch blocks to create the following model. In this example, the

model is named local_variable_ex.

2 For G2, open the Gain Block Parameters dialog box. Enter a value of 2.
3 For G1, enter a value of 3.
4 For the Switch block, open the Block Parameters dialog box. For the Criteria for passing first

input parameter, select u2>=Threshold.

Generate Code Without Optimization
1 Open the Model Configuration Parameters dialog box. Select the Solver pane. For the Type

parameter, select Fixed-step.
2 Clear the Configuration Parameters > Signal storage reuse parameter.
3 Select the Code Generation > Report pane and select Create code generation report.
4 Select the Code Generation pane. Select Generate code only, and then, in the model window,

press Ctrl+B. When code generation is complete, an HTML code generation report appears.
5 In the code generation report, select the local_variable_ex.c section and view the model

step function. The Gain block outputs are the global variables local_variable_ex_B.G2 and
local_variable_ex_B.G1.
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/* Model step function */
void local_variable_ex_step(void)
{
  /* Switch: '<Root>/Switch' incorporates:
   *  Inport: '<Root>/In1'
   */
  if (local_variable_ex_U.In1 >= 0.0) {
    /* Gain: '<Root>/G2' */
    local_variable_ex_B.G2 = 2.0 * local_variable_ex_U.In1;

    /* Outport: '<Root>/Out1' */
    local_variable_ex_Y.Out1 = local_variable_ex_B.G2;
  } else {
    /* Gain: '<Root>/G1' */
    local_variable_ex_B.G1 = 3.0 * local_variable_ex_U.In1;

    /* Outport: '<Root>/Out1' */
    local_variable_ex_Y.Out1 = local_variable_ex_B.G1;
  }

  /* End of Switch: '<Root>/Switch' */

Enable Local Block Outputs and Generate Code
1 Select the Configuration Parameters > Signal Storage Reuse parameter. The Signal

Storage Reuse enables the following optimization parameters:

• Enable local block outputs
• Reuse local block outputs
• Eliminate superfluous local variables (expression folding)

2 Clear Reuse local block outputs and Eliminate superfluous local variables (expression
folding).

3 Generate code and view the model step function. There are three local variables in the model
step function because you selected the optimization parameter Enable Local Block Outputs.
The local variables rtb_G2 and rtb_G1 hold the outputs of the Gain blocks. The local variable
rtb_Switch holds the output of the Switch block.

/* Model step function */
void local_variable_ex_step(void)
{
  real_T rtb_Switch;
  real_T rtb_G2;
  real_T rtb_G1;

  /* Switch: '<Root>/Switch' incorporates:
   *  Inport: '<Root>/In1'
   */
  if (local_variable_ex_U.In1 >= 0.0) {
    /* Gain: '<Root>/G2' */
    rtb_G2 = 2.0 * local_variable_ex_U.In1;
    rtb_Switch = rtb_G2;
  } else {
    /* Gain: '<Root>/G1' */
    rtb_G1 = 3.0 * local_variable_ex_U.In1;
    rtb_Switch = rtb_G1;
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  }

  /* End of Switch: '<Root>/Switch' */

  /* Outport: '<Root>/Out1' */
  local_variable_ex_Y.Out1 = rtb_Switch;

Reuse Local Block Outputs and Generate Code
1 Select the Configuration Parameters > Reuse local block outputs parameter.
2 Generate code. In the local_variable_ex.c section, view the model step function. There is

one local variable, rtb_G2, that the code generator uses three times.

/* Model step function */
void local_variable_ex_step(void)
{
  real_T rtb_G2;

  /* Switch: '<Root>/Switch' incorporates:
   *  Inport: '<Root>/In1'
   */
  if (local_variable_ex_U.In1 >= 0.0) {
    /* Gain: '<Root>/G2' */
    rtb_G2 = 2.0 * local_variable_ex_U.In1;
  } else {
    /* Gain: '<Root>/G1' */
    rtb_G2 = 3.0 * local_variable_ex_U.In1;
  }

  /* End of Switch: '<Root>/Switch' */

  /* Outport: '<Root>/Out1' */
  local_variable_ex_Y.Out1 = rtb_G2;

The extra temporary variable rtb_Switch and the associated data copy is not in the generated code.

See Also
“Enable local block outputs”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Customize Stack Space Allocation” on page 69-92
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 34-49
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Set Hardware Implementation Parameters
Specification of target hardware device characteristics (such as word sizes for char, short, int, and
long data types, or desired rounding behaviors in integer operations) for generated code can be
critical in embedded systems development. The Hardware Implementation category of parameters
in a configuration set provides a way to control such characteristics in simulation and code
generation.

By configuring the Hardware Implementation parameters of the active configuration set for a
model to match the behaviors of your compiler and hardware, you can generate more efficient code.
For example, if you specify the Byte ordering parameter, you can avoid generation of extra code that
tests the byte ordering of the target CPU.

Before generating and deploying code, get familiar with the Hardware Implementation pane of the
Configuration Parameters dialog box. By default, target hardware microprocessor device details are
hidden. To view the details, click the Device details arrow. See “Hardware Implementation Pane”
and “Configure Run-Time Environment Options” for more information.
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Data Copy Reduction in Embedded
Coder

• “Optimize Global Variable Usage” on page 71-2
• “Reuse Global Block Outputs in the Generated Code” on page 71-12
• “Virtualized Output Ports Optimization” on page 71-15
• “Specify Buffer Reuse by Using Simulink.Signal Objects” on page 71-17
• “Specify Buffer Reuse for MATLAB Function Blocks in a Path” on page 71-23
• “Remove Data Copies by Reordering Block Operations in the Generated Code” on page 71-25
• “Data Copy Reduction for Data Store Read and Data Store Write Blocks” on page 71-30
• “Reduce Data Copies for Bus Assignment Blocks” on page 71-34
• “Optimize Generated Code by Using Signal Labels to Guide Buffer Reuse” on page 71-37
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Optimize Global Variable Usage

In this section...
“Use Global to Hold Temporary Results” on page 71-2
“Minimize Global Data Access” on page 71-6

To tune your application and choose tradeoffs for execution speed and memory usage, you can choose
a global variable reference optimization for the generated code.

On the Configuration Parameters dialog box, in the Optimize global data access drop-down list,
three parameter options control global variable usage optimizations.

• None. Use default optimizations. This choice works well for most models. The code generator
balances the use of local and global variables. It generates code which balances RAM and ROM
consumption and execution speed.

• Use global to hold temporary results. Reusing global variables improves code efficiency
and readability. This optimization reuses global variables, which results in the code generator
defining fewer variables. It reduces RAM and ROM consumption and data copies.

• Minimize global data access. Using local variables to cache global data reduces ROM
consumption by reducing code size. This optimization improves execution speed because the code
uses fewer instructions for local variable references than for global variable references.

Minimizing the use of global variables by using local variables interacts with stack usage control.
For example, stack size can determine the number of local and global variables that the code
generator can allocate in the generated code. For more information, see “Customize Stack Space
Allocation”.

Use Global to Hold Temporary Results
The code generator uses global and local variables when you select None versus when you select Use
global to hold temporary results.

Example Model

In the model matlab:rtwdemo_optimize_global_ebf, an Assignment block assigns values coming from
the Inport and Constant blocks to an output signal. The output signal feeds into a Gain block.

model = 'rtwdemo_optimize_global_ebf';
load_system('rtwdemo_optimize_global_ebf')
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Generate Code without Optimization

1 In the Configuration Parameters dialog box, verify that the Signal storage reuse parameter is
selected.

2 In the Configuration Parameters dialog box, for the Optimize global data access parameter,
select None or enter the following command in the MATLAB Command Window:

set_param('rtwdemo_optimize_global_ebf','GlobalVariableUsage','None');

In your system's temporary folder, create a folder for the build and inspection process:

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model);

### Starting build procedure for: rtwdemo_optimize_global_ebf
### Successful completion of build procedure for: rtwdemo_optimize_global_ebf

Build Summary

Top model targets built:

Model                        Action                       Rebuild Reason                                    
============================================================================================================
rtwdemo_optimize_global_ebf  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 1m 5.269s

View the generated code without the optimization. Here is a portion of
rtwdemo_optimize_global_ebf.c.

cfile = fullfile(cgDir,'rtwdemo_optimize_global_ebf_ert_rtw',...
    'rtwdemo_optimize_global_ebf.c');
rtwdemodbtype(cfile,'/* Model step','/* Model initialize',1, 0);

/* Model step function */
void rtwdemo_optimize_global_ebf_step(void)
{
  real_T rtb_Assignment[5];
  int32_T i;

  /* SignalConversion generated from: '<Root>/Assignment' incorporates:
   *  Constant: '<Root>/Constant'
   */
  for (i = 0; i < 5; i++) {
    rtb_Assignment[i] = rtCP_Constant_Value[i];
  }

  /* End of SignalConversion generated from: '<Root>/Assignment' */

  /* Assignment: '<Root>/Assignment' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtb_Assignment[1] = rtU.In1;
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  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   */
  for (i = 0; i < 5; i++) {
    rtY.Out1[i] = 2.0 * rtb_Assignment[i];
  }

  /* End of Outport: '<Root>/Out1' */
}

The code assigns values to the local vector rtb_Assignment. The last statement copies the values in
the local vector rtb_Assignment to the global vector rtY.Out1. Fewer global variable references
result in improved execution speed. The code uses more instructions for global variable references
than for local variable references.

In the Static Code Metrics Report, examine the Global Variables section.

1 In the Code Generation Report window, select Static Code Metrics Report.
2 Scroll down to the Global Variables section.
3 Select the [+] sign before each variable to expand it.

The total number of reads and writes for global variables is 2.

Generate Code with Optimization

In the Configuration Parameters dialog box, for the Optimize global data access parameter, select
Use global to hold temporary results, or enter the following command in the MATLAB
Command Window:

set_param('rtwdemo_optimize_global_ebf',...
    'GlobalVariableUsage','Use global to hold temporary results');

Build the model.

slbuild(model);

### Starting build procedure for: rtwdemo_optimize_global_ebf
### Successful completion of build procedure for: rtwdemo_optimize_global_ebf
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Build Summary

Top model targets built:

Model                        Action                       Rebuild Reason                   
===========================================================================================
rtwdemo_optimize_global_ebf  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 24.262s

View the generated code with the optimization. Here is a portion of
rtwdemo_optimize_global_ebf.c.

cfile = fullfile(cgDir,'rtwdemo_optimize_global_ebf_ert_rtw',...
    'rtwdemo_optimize_global_ebf.c');
rtwdemodbtype(cfile,'/* Model step','/* Model initialize',1, 0);

/* Model step function */
void rtwdemo_optimize_global_ebf_step(void)
{
  int32_T i;

  /* SignalConversion generated from: '<Root>/Assignment' incorporates:
   *  Constant: '<Root>/Constant'
   */
  for (i = 0; i < 5; i++) {
    rtY.Out1[i] = rtCP_Constant_Value[i];
  }

  /* End of SignalConversion generated from: '<Root>/Assignment' */

  /* Assignment: '<Root>/Assignment' incorporates:
   *  Inport: '<Root>/In1'
   */
  rtY.Out1[1] = rtU.In1;

  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   */
  for (i = 0; i < 5; i++) {
    rtY.Out1[i] *= 2.0;
  }

  /* End of Outport: '<Root>/Out1' */
}

The code assigns values to the global vector rtY.Out1 without using a local variable. This
assignment improves ROM and RAM consumption and reduces data copies. The code places the value
in the destination variable for each assignment instead of copying the value at the end. In the Static
Code Metrics Report, examine the Global Variables section.
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As a result of using global variables to hold local results, the total number of reads and writes for
global variables has increased from 2 to 5. This optimization reduces data copies by reusing global
variables.

Close the code generation report.

rtwdemoclean;
cd(currentDir)

Minimize Global Data Access
Generate optimized code that reads from and writes to global variables less frequently.

Example Model

In the model matlab:rtwdemo_optimize_global, five signals feed into a Multiport Switch block.

model = 'rtwdemo_optimize_global';
load_system('rtwdemo_optimize_global')
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Generate Code without Optimization
1 In the Configuration Parameters dialog box, verify that the Signal storage reuse parameter is

selected.
2 In the Configuration Parameters dialog box, for the Optimize global data access parameter,

select None or enter the following command in the MATLAB Command Window:

set_param('rtwdemo_optimize_global','GlobalVariableUsage','None');

In your system's temporary folder, create a folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model);

### Starting build procedure for: rtwdemo_optimize_global
### Successful completion of build procedure for: rtwdemo_optimize_global

Build Summary

Top model targets built:

Model                    Action                       Rebuild Reason                                    
========================================================================================================
rtwdemo_optimize_global  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.785s
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View the generated code without the optimization. Here is a portion of
rtwdemo_optimize_global.c.

cfile = fullfile(cgDir,'rtwdemo_optimize_global_ert_rtw',...
    'rtwdemo_optimize_global.c');
rtwdemodbtype(cfile,'/* Model step','/* Model initialize',1, 0);

/* Model step function */
void rtwdemo_optimize_global_step(void)
{
  /* MultiPortSwitch: '<Root>/Multiport Switch' incorporates:
   *  Inport: '<Root>/In1'
   */
  switch ((int32_T)rtU.In1) {
   case 1:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant'
     */
    rtY.Out1 = 1.0;
    break;

   case 2:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant1'
     */
    rtY.Out1 = 2.0;
    break;

   case 3:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant2'
     */
    rtY.Out1 = 3.0;
    break;

   default:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant3'
     */
    rtY.Out1 = 4.0;
    break;
  }

  /* End of MultiPortSwitch: '<Root>/Multiport Switch' */
}

In the Static Code Metrics Report, examine the Global Variables section.

1 In the Code Generation Report window, select Static Code Metrics Report.
2 Scroll down to the Global Variables section.
3 Select the [+] sign before each variable to expand it.

71 Data Copy Reduction in Embedded Coder

71-8



The total number of reads and writes for global variables is 5.

Enable Optimization and Generate Code

In the Configuration Parameters dialog box, for the Optimize global data access parameter, select
Minimize global data access or enter the following command in the MATLAB Command
Window:

set_param('rtwdemo_optimize_global',...
    'GlobalVariableUsage','Minimize global data access');

Build the model.

slbuild(model);

### Starting build procedure for: rtwdemo_optimize_global
### Successful completion of build procedure for: rtwdemo_optimize_global

Build Summary

Top model targets built:

Model                    Action                       Rebuild Reason                   
=======================================================================================
rtwdemo_optimize_global  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.542s

View the generated code with the optimization. Here is a portion of rtwdemo_optimize_global.c.

cfile = fullfile(cgDir,'rtwdemo_optimize_global_ert_rtw',...
    'rtwdemo_optimize_global.c');
rtwdemodbtype(cfile,'/* Model step','/* Model initialize',1, 0);

/* Model step function */
void rtwdemo_optimize_global_step(void)
{
  real_T tmp_Out1;

  /* MultiPortSwitch: '<Root>/Multiport Switch' incorporates:
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   *  Inport: '<Root>/In1'
   */
  switch ((int32_T)rtU.In1) {
   case 1:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant'
     */
    tmp_Out1 = 1.0;
    break;

   case 2:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant1'
     */
    tmp_Out1 = 2.0;
    break;

   case 3:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant2'
     */
    tmp_Out1 = 3.0;
    break;

   default:
    /* Outport: '<Root>/Out1' incorporates:
     *  Constant: '<Root>/Constant3'
     */
    tmp_Out1 = 4.0;
    break;
  }

  /* End of MultiPortSwitch: '<Root>/Multiport Switch' */

  /* Outport: '<Root>/Out1' */
  rtY.Out1 = tmp_Out1;
}

In rtwdemo_optimize_global.c, the code assigns a constant value to the local variable tmp_Out1
in each case statement. The last statement in the code copies the value of tmp_Out1 to the global
variable rtY.Out1. Fewer global variable references result in fewer instructions and improved
execution speed.

In the Static Code Metrics Report, examine the Global Variables section. As a result of
minimizing global data accesses, the total number of reads and writes for global variables has
decreased from 5 to 2.
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Close the code generation report.

rtwdemoclean;
cd(currentDir)

See Also
“Optimize global data access”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
• “Customize Stack Space Allocation” on page 69-92
• “Reuse Global Block Outputs in the Generated Code” on page 71-12
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Reuse Global Block Outputs in the Generated Code
Reduce ROM and RAM consumption and data copies and increase execution speed of generated code.
Configure the code generator to reuse global variables by selecting the model configuration
parameter Reuse global block outputs.

Example

In the Command Window, type rtwdemo_reuse_global.

Generate Code without Optimization

1 On the Configuration Parameters dialog box, verify that Signal storage reuse is selected.
2 Clear Reuse global block outputs and click Apply.
3 On the Code Generation > Report pane, select Generate static code metrics.
4 In your system's temporary folder, create a folder for the build and inspection process.

Press Ctrl+B to generate code.

### Starting build procedure for: rtwdemo_reuse_global
### Successful completion of build procedure for: rtwdemo_reuse_global

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
rtwdemo_reuse_global  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 11.724s

View the generated code without the optimization. Here is a portion of rtwdemo_reuse_global.c.

/* Model step function */
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void rtwdemo_reuse_global_step(void)
{
  /* Sum: '<Root>/Sum' incorporates:
   *  Delay: '<Root>/Delay'
   *  Inport: '<Root>/In1'
   */
  rtDW.Delay_DSTATE += rtU.In1;

  /* Outport: '<Root>/Out1' incorporates:
   *  Delay: '<Root>/Delay'
   */
  rtY.Out1 = rtDW.Delay_DSTATE;
}

The generated code contains a data copy to the global variable rtDW.Delay_DSTATE. Open the
Static Code Metrics Report. The total number of reads and writes for global variables is 8. The total
size is 32 bytes.

Enable Optimization and Generate Code

1 On the Configuration Parameters dialog box, select Reuse global block outputs and click
Apply.

2 Generate code.
3 View the generated code with the optimization. Here is a portion of rtwdemo_reuse_global.c.

### Starting build procedure for: rtwdemo_reuse_global
### Successful completion of build procedure for: rtwdemo_reuse_global

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                   
====================================================================================
rtwdemo_reuse_global  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.078s

/* Model step function */
void rtwdemo_reuse_global_step(void)
{
  /* Sum: '<Root>/Sum' incorporates:
   *  Delay: '<Root>/Delay'
   *  Inport: '<Root>/In1'
   */
  rtY.Out1 += rtU.In1;
}

The code generator eliminates a data copy, reduces two statements to one statement and three global
variables to two global variables.
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Open the Static Code Metrics Report. For global variables, this optimization reduces the total number
of reads and writes for global variables from 8 to 5 and the total size from 32 bytes to 24 bytes.

See Also
“Reuse global block outputs”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 69-35
• “Optimize Global Variable Usage” on page 71-2
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Virtualized Output Ports Optimization
The virtualized output ports optimization lets you store the signal entering the root output port as a
global variable. Clearing the MAT-file logging option and setting the TLC variable
FullRootOutputVector to 0, both defaults for Embedded Coder, eliminate code and data storage
associated with root output ports.

Consider the model in the following block diagram. The signal exportedSig has exportedGlobal
storage class.

In the default case, the output of the Gain block is written to the signal storage location,
exportedSig. The code generator does not generate code or data for the Out1 block, which has
become a virtual block.

/* Gain Block: <Root>/Gain */
  exportedSig = rtb_PulseGen * VirtOutPortLogOFF_P.Gain_Gain;

In cases where you enable MAT-file logging or set FullRootOutputVector = 1, the generated
code represents root output ports as members of an external outputs vector.

The following code fragment was generated with MAT-file logging enabled. The output port is
represented as a member of the external outputs vector VirtOutPortLogON_Y. The Gain block
output value is copied to exportedSig and to the external outputs vector.

/* Gain Block: <Root>/Gain */
  exportedSig = rtb_PulseGen * VirtOutPortLogON_P.Gain_Gain;

/* Outport Block: <Root>/Out1 */
  VirtOutPortLogON_Y.Out1 = exportedSig;

Data maintenance in the external outputs vector can be significant for smaller models that perform
benchmarks.

You can force root output ports to be stored in the external outputs vector (regardless of the setting
of MAT-file logging) by setting the TLC variable FullRootOutputVector to 1. Add the statement

%assign FullRootOutputVector = 1

to the Embedded Coder system target file. Alternatively, you can enter the assignment from the
MATLAB command line using the set_param command, the model parameter TLCOptions, and the
TLC option -a. For more information, see “Specify TLC for Code Generation” and “Configure TLC”.

For more information on how to control signal storage in generated code, see “How Generated Code
Stores Internal Signal, State, and Parameter Data” on page 34-49 and “C Code Generation
Configuration for Model Interface Elements” on page 33-2.
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See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Specify Buffer Reuse by Using Simulink.Signal Objects” on page 71-17
• “Optimize Global Variable Usage” on page 71-2

71 Data Copy Reduction in Embedded Coder

71-16



Specify Buffer Reuse by Using Simulink.Signal Objects
If your model has the optimal parameter settings for removing data copies, you might be able to
remove additional data copies by using Simulink.Signal objects to specify buffer reuse. After
studying the generated code and the Static Code Metrics Report and identifying areas where you
think buffer reuse is possible, you specify signal objects on signal lines.

You can specify buffer reuse on signals that include a pair of root inport and outport signals. You can
also specify buffer reuse on just a pair of root inport and outport signals. This optimization reduces
ROM and RAM consumption because there are less global variables and data copies in the generated
code. Code execution speed also increases.

Example Model

The model rtwdemo_reusable_csc contains the nonreusable subsystem DeltaSubsystem and the
MATLAB Function block Downsample. DeltaSubsystem contains the MATLAB Function blocks
DeltaX and DeltaY.

model ='rtwdemo_reusable_csc';
open_system(model);

Specify a Simulink Signal Object for Reuse

1 In the Apps gallery, under Code generation, click Embedded Coder . The C Code tab opens.
2 To open the Code Mappings editor, click Code Interface > Individual Element Code

Mappings .
3 In the model, select the RCSC_REAL signal line. To view this signal or any signal in the Code

Mappings editor, on the Signals/States tab, click the Add selected signals to code mappings
button.

4 For the row that represents the signal line, inspect the Storage Class column. The signal object
uses the storage class Reusable, which means the object appears in the generated code as a
global variable named RCSC_REAL.

5 In the model, navigate into the DeltaSubsystem subsystem.
6 Select the RCSC_REAL signal line in this subsystem. This signal also resolves to the signal object

in the base workspace.

With the Reusable storage class, the generated code can store the output of the Complex to
Real-Imag block (at the root level of the model) and the output of the DeltaX block (in the
subsystem) in the RCSC_REAL global variable.
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Generate Code

Build the model.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
slbuild(model);

### Starting build procedure for: rtwdemo_reusable_csc
### Successful completion of build procedure for: rtwdemo_reusable_csc

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
rtwdemo_reusable_csc  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 24.773s

For buffer reuse, the rtwdemo_reusable_csc.c file contains these global variables:

• static real_T RCSC_IMAG[1048576];
• static real_T RCSC_IMAG2[262144];
• static real_T RCSC_REAL[1048576];
• static real_T RCSC_REAL2[262144];

The rtwdemo_reusable_csc.c file contains this code:

cfile = fullfile(cgDir,...
    'rtwdemo_reusable_csc_ert_rtw','rtwdemo_reusable_csc.c');
rtwdemodbtype(cfile,...
    '/* Output and update for atomic system: ''<Root>/DeltaSubsystem'' */',...
    '/* Output and update for atomic system: ''<Root>/Downsample'' */',1,0);
rtwdemodbtype(cfile,...
    '/* Model step function */','/* Model initialize function */',1,0);

/* Output and update for atomic system: '<Root>/DeltaSubsystem' */
static void DeltaSubsystem(void)
{
  /* SignalConversion generated from: '<S1>/DeltaX' incorporates:
   *  MATLAB Function: '<S1>/DeltaX'
   */
  DeltaX((&(RCSC_REAL2[0])), (&(RCSC_IMAG2[0])), (&(RCSC_REAL[0])),
         (&(RCSC_IMAG[0])));

  /* SignalConversion generated from: '<S1>/DeltaY' incorporates:
   *  MATLAB Function: '<S1>/DeltaY'
   */
  DeltaY((&(RCSC_REAL[0])), (&(RCSC_IMAG[0])), (&(RCSC_REAL2[0])),
         (&(RCSC_IMAG2[0])));
}

/* Model step function */
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void rtwdemo_reusable_csc_step(void)
{
  int32_T i;

  /* ComplexToRealImag: '<Root>/Complex to Real-Imag' incorporates:
   *  Inport: '<Root>/ComplexData'
   */
  for (i = 0; i < 1048576; i++) {
    RCSC_REAL[i] = rtU.ComplexData[i].re;
    RCSC_IMAG[i] = rtU.ComplexData[i].im;
  }

  /* End of ComplexToRealImag: '<Root>/Complex to Real-Imag' */

  /* MATLAB Function: '<Root>/Downsample' */
  Downsample((&(RCSC_REAL[0])), (&(RCSC_IMAG[0])), (&(RCSC_REAL2[0])),
             (&(RCSC_IMAG2[0])));

  /* Outputs for Atomic SubSystem: '<Root>/DeltaSubsystem' */
  DeltaSubsystem();

  /* End of Outputs for SubSystem: '<Root>/DeltaSubsystem' */

  /* Outport: '<Root>/Out1' incorporates:
   *  RealImagToComplex: '<Root>/Real-Imag to Complex'
   *  SignalConversion generated from: '<S1>/DeltaY'
   * */
  for (i = 0; i < 261121; i++) {
    rtY.Out1[i].re = RCSC_REAL2[i];
    rtY.Out1[i].im = RCSC_IMAG2[i];
  }

  /* End of Outport: '<Root>/Out1' */
}

The variables RCSC_REAL and RCSC_IMAG hold the outputs of the Complex to Real-Image block and
DeltaX. These variables hold the inputs to the DeltaY block. The variables RCSC_REAL2 and
RCSC_IMAG2 hold the outputs of Downsample and DeltaY. These variables hold the inputs to the
DeltaX block. By interleaving buffers in this way, you eliminate global variables in the generated
code.

To remove the signal objects from the signal lines and regenerate code, in the MATLAB Command
Window, enter these commands:

portHandles = get_param(...
    'rtwdemo_reusable_csc/Complex to Real-Imag','portHandles');
set_param(portHandles.Outport(1),'MustResolveToSignalObject','off');
set_param(portHandles.Outport(2),'MustResolveToSignalObject','off');

portHandles = get_param(...
    'rtwdemo_reusable_csc/Downsample','portHandles');
set_param(portHandles.Outport(1),'MustResolveToSignalObject','off');
set_param(portHandles.Outport(2),'MustResolveToSignalObject','off');

portHandles = get_param(...
    'rtwdemo_reusable_csc/DeltaSubsystem/DeltaX','portHandles');
set_param(portHandles.Outport(1),'MustResolveToSignalObject','off');
set_param(portHandles.Outport(2),'MustResolveToSignalObject','off');
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portHandles = get_param(...
    'rtwdemo_reusable_csc/DeltaSubsystem/DeltaY','portHandles');
set_param(portHandles.Outport(1),'MustResolveToSignalObject','off');
set_param(portHandles.Outport(2),'MustResolveToSignalObject','off');

slbuild(model);

### Starting build procedure for: rtwdemo_reusable_csc
### Successful completion of build procedure for: rtwdemo_reusable_csc

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                   
====================================================================================
rtwdemo_reusable_csc  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 18.383s

The rtwdemo_reusable_csc.c file now contains this code.

cfile = fullfile(cgDir,...
    'rtwdemo_reusable_csc_ert_rtw','rtwdemo_reusable_csc.c');
rtwdemodbtype(cfile,...
    '/* Output and update for atomic system: ''<Root>/DeltaSubsystem'' */',...
    '/* Output and update for atomic system: ''<Root>/Downsample'' */',1,0);
rtwdemodbtype(cfile,...
    '/* Model step function */','/* Model initialize function */',1,0);

/* Output and update for atomic system: '<Root>/DeltaSubsystem' */
static void DeltaSubsystem(void)
{
  /* MATLAB Function: '<S1>/DeltaX' */
  DeltaX(rtDWork.z2, rtDWork.z1, rtDWork.z1_m, rtDWork.z2_c);

  /* MATLAB Function: '<S1>/DeltaY' */
  DeltaY(rtDWork.z1_m, rtDWork.z2_c, &rtDWork.z1[0], &rtDWork.z2[0]);
}

/* Model step function */
void rtwdemo_reusable_csc_step(void)
{
  int32_T i;

  /* ComplexToRealImag: '<Root>/Complex to Real-Imag' incorporates:
   *  Inport: '<Root>/ComplexData'
   */
  for (i = 0; i < 1048576; i++) {
    rtDWork.RCSC_REAL[i] = rtU.ComplexData[i].re;
    rtDWork.RCSC_IMAG[i] = rtU.ComplexData[i].im;
  }

  /* End of ComplexToRealImag: '<Root>/Complex to Real-Imag' */
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  /* MATLAB Function: '<Root>/Downsample' */
  Downsample(rtDWork.RCSC_REAL, rtDWork.RCSC_IMAG, rtDWork.z2, rtDWork.z1);

  /* Outputs for Atomic SubSystem: '<Root>/DeltaSubsystem' */
  DeltaSubsystem();

  /* End of Outputs for SubSystem: '<Root>/DeltaSubsystem' */

  /* Outport: '<Root>/Out1' incorporates:
   *  RealImagToComplex: '<Root>/Real-Imag to Complex'
   */
  for (i = 0; i < 261121; i++) {
    rtY.Out1[i].re = rtDWork.z1[i];
    rtY.Out1[i].im = rtDWork.z2[i];
  }

  /* End of Outport: '<Root>/Out1' */
}

The generated code contains two additional global variables for holding block inputs and outputs.

Note: You can specify buffer reuse on signals that the code generator cannot implement. For those
cases, use two diagnostics to specify the message type that the model displays. In the Configuration
Parameters dialog box, these diagnostics are Detect non-reused custom storage classes and
Detect ambiguous custom storage class final values.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Buffer Reuse for Unit Delay and Delay Blocks

To reuse the signal of a Unit Delay or Delay block, use the same reusable storage class specification
for a pair of input and state arguments or a pair of output and state arguments of a Unit Delay or a
Delay block. For Delay blocks, you must set the Delay length parameter to 1 and Initial condition
> Source to Dialog. To access these parameters, in the model, open the Property Inspector and
click the block in the model.

Limitations for Root Inport and Outport Signals

These limitations apply to a model in which you specify buffer reuse for a pair of root inport and
outport signals:

• The output ports cannot be conditional.
• If the code generator cannot reuse the same buffer in a top model, the generated code contains

additional buffers. If the top model is a reference model, the code generator reports an error. To
resolve the error, remove the Simulink.signal specification from the signal that connects to the
outport port.

• When you run the executable that the code generator produces, and you reuse a pair of root
inport and outport signals, when the root input value is zero, the root output value must also be
zero. If the output value is nonzero and you reuse the signals, then the results from the simulation
can differ from the results that the executable produces.

• There might be a simulation versus code generation mismatch when you assign the same Reusable
storage class to pair of root inport and root outport signals. This mismatch occurs when an
Assignment block drives the Root Outport block, and the Assignment block does not assign a value
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to every element of the output signal because the Y port of the Assignment block is not active.
This image shows a model in which the mismatch occurs:

During simulation, the unwritten Assignment block output values are zero. During code generation,
the unwritten output values are the same as the input.

Limitations for the Model

These limitations apply to a model in which you specify buffer reuse for signals:

• Signals that you specify for reuse must have the same data types and sampling rates.
• For user-specified buffer reuse, blocks that modify a signal specified for reuse must execute before

blocks that use the original signal value. Sometimes the code generator has to change the block
operation order so that buffer reuse can occur. For models in which the code generator is unable
to reorder block operations, buffer reuse does not occur.

• For models in which the code generator reorders block operations so that Simulink.Signal
reuse can occur, you can observe the difference in the sorted order. On the Debug tab, in the
Diagnostics section select the Information Overlays drop-down arrow. In the Blocks section of
the dialog, select Execution Order. To display the sorted execution order during simulation, on
the Modeling tab, select Update Model . To display the execution order in the generated code,
on the C Code tab, select Build Model.

• You can specify buffer reuse for a chain of reusable subsystems as long as these subsystems do not
get reused anywhere in the model.

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “C Code Generation Configuration for Model Interface Elements”
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 34-74
• “Virtualized Output Ports Optimization” on page 71-15
• “Design Data Interface by Configuring Inport and Outport Blocks” on page 34-167
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Specify Buffer Reuse for MATLAB Function Blocks in a Path
In this section...
“Example Model” on page 71-23
“Generate Code with Optimization” on page 71-23

You can specify buffer reuse across MATLAB Function blocks by using the same variable name for the
input and output arguments. The code generator tries to reuse the output of one MATLAB Function
block as the input to the next MATLAB Function block. This optimization conserves RAM and ROM
consumption and reduces data copies.

Example Model
1 Use Inport, Outport, and MATLAB Function blocks to create the model mf_inplace.

2 Open each MATLAB Function block and copy the following code:

function y = fcn(y)
%#codegen

y=y+4;
3 Open the Configuration Parameters dialog box. On the Code Generation tab, change the

System target file to ert.tlc.
4 On the Solver tab, change the Type parameter to Fixed-step.

Generate Code with Optimization
Generate code for the model. The mf_inplace.c file contains this code:

void mf_inplace_MATLABFunction(real_T *rty_y)
{
  *rty_y += 4.0;
}
 
void mf_inplace_step(void)
{
  real_T rtb_y_p5;
  rtb_y_p5 = mf_inplace_U.In1;
  mf_inplace_MATLABFunction(&rtb_y_p5);
  mf_inplace_MATLABFunction(&rtb_y_p5);
  mf_inplace_MATLABFunction(&rtb_y_p5);
  mf_inplace_Y.Out1 = rtb_y_p5;
  mf_inplace_MATLABFunction(&mf_inplace_Y.Out1);
}
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The code generator reuses the variable rtb_y_p5 for the input and output arguments of each
MATLAB Function block.

Note On the Code Generation tab in the Subsystem Block Parameters dialog box, if the Function
packaging parameter is set to Nonreusable function and the Function interface parameter is
set to Allow arguments (Optimized), the code generator cannot reuse the input and output
arguments.

See Also

Related Examples
• “Implementing MATLAB Functions Using Blocks”
• “Specify Buffer Reuse by Using Simulink.Signal Objects” on page 71-17
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Remove Data Copies by Reordering Block Operations in the
Generated Code

This example show how to remove data copies by changing the Optimize block order in the
generated code parameter from off to Improved Execution Speed. Changing this setting
indicates to the code generator to reorder block operations where possible to remove data copies.
This parameter is in the Configuration Parameters dialog box. This optimization conserves RAM and
ROM consumption.

Example Model
In the model ex_optimizeblockorder, the signal that leaves the Sum block enters a Subtract
block and a Concatenate block. The signal that leaves the Subtract block enters a Product block and a
Sum of Elements block.

Generate Code without Optimization
The image shows the model ex_optimizeblockorder after a model build. The red numbers
indicate the default block order in the generated code. The Subtract block executes before the
Concatenate block. The Product block executes before the Sum of Elements block.
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View the generated code without the optimization. Here is the ex_optimizeblockorder_step
function.

/* Model step function */
void ex_optimizeblockorder_step(void)
{
  real_T rtb_Sum2x3[6];
  int32_T i;
  real_T rtb_Sum2x3_d;
  real_T rtb_Subtract;

  /* Sum: '<Root>/SumOfElements' */
  rtY.Out2 = -0.0;
  for (i = 0; i < 6; i++) {
    /* Sum: '<Root>/Sum2x3' incorporates:
     *  Inport: '<Root>/In1'
     *  Inport: '<Root>/In2'
     */
    rtb_Sum2x3_d = rtU.In1[i] + rtU.In2;

    /* Sum: '<Root>/Subtract' incorporates:
     *  Inport: '<Root>/In3'
     */
    rtb_Subtract = rtb_Sum2x3_d - rtU.In3;

    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/In4'
     *  Product: '<Root>/Product'
     */
    rtY.Out1[i] = rtU.In4[i] * rtb_Subtract;

    /* Sum: '<Root>/Sum2x3' */
    rtb_Sum2x3[i] = rtb_Sum2x3_d;
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    /* Sum: '<Root>/SumOfElements' */
    rtY.Out2 += rtb_Subtract;
  }

  /* Concatenate: '<Root>/MatrixConcat ' */
  for (i = 0; i < 3; i++) {
    /* Outport: '<Root>/Out3' incorporates:
     *  Inport: '<Root>/In5'
     */
    rtY.Out3[i << 2] = rtb_Sum2x3[i << 1];
    rtY.Out3[2 + (i << 2)] = rtU.In5[i << 1];
    rtY.Out3[1 + (i << 2)] = rtb_Sum2x3[(i << 1) + 1];
    rtY.Out3[3 + (i << 2)] = rtU.In5[(i << 1) + 1];
  }

  /* End of Concatenate: '<Root>/MatrixConcat ' */
}

With the default order, the generated code contains three buffers, rtb_Sum2x3[6], rtb_Sum2x3_d,
and rtb_Subtract. The generated code contains these temporary variables and associated data
copies because the Matrix Concatenate block must use the output from the Sum block and the Sum of
Elements block must use the output from the Subtract block.

Generate Code with Optimization
The image shows the ex_optimizeblockorder model after setting the Optimize block operation
order in the generated code parameter to Improved Execution Speed and building the model.
The Subtract block executes after the Concatenate block. The Product block executes after the Sum
of Elements block.
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In the optimized code, the three buffers rtb_Sum2x3[6], rtb_Sum2x3_d, and rtb_Subtract and
their associated data copies are gone. The generated code does not require these temporary variables
to hold the outputs of the Sum and Subtract blocks because the Subtract block executes after the
Concatenate block and the Product block executes after the Sum of Elements block.

/* Model step function */
void ex_optimizeblockorder_step(void)
{
  int32_T i;

  /* Sum: '<Root>/Sum2x3' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   */
  for (i = 0; i < 6; i++) {
    rtY.Out1[i] = rtU.In1[i] + rtU.In2;
  }

  /* End of Sum: '<Root>/Sum2x3' */

  /* Concatenate: '<Root>/MatrixConcat ' */
  for (i = 0; i < 3; i++) {
    /* Outport: '<Root>/Out3' incorporates:
     *  Inport: '<Root>/In5'
     */
    rtY.Out3[i << 2] = rtY.Out1[i << 1];
    rtY.Out3[2 + (i << 2)] = rtU.In5[i << 1];
    rtY.Out3[1 + (i << 2)] = rtY.Out1[(i << 1) + 1];
    rtY.Out3[3 + (i << 2)] = rtU.In5[(i << 1) + 1];
  }

  /* End of Concatenate: '<Root>/MatrixConcat ' */

  /* Sum: '<Root>/SumOfElements' */
  rtY.Out2 = -0.0;
  for (i = 0; i < 6; i++) {
    /* Sum: '<Root>/Subtract' incorporates:
     *  Inport: '<Root>/In3'
     */
    rtY.Out1[i] -= rtU.In3;

    /* Sum: '<Root>/SumOfElements' */
    rtY.Out2 += rtY.Out1[i];

    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/In4'
     *  Product: '<Root>/Product'
     */
    rtY.Out1[i] *= rtU.In4[i];
  }
}

To implement buffer reuse, the code generator does not violate user-specified block priorities.

See Also
“Optimize block operation order in the generated code”
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Related Examples
• “Improve Execution Efficiency by Reordering Block Operations in the Generated Code” on page

72-48
• “Data Copy Reduction”
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Data Copy Reduction for Data Store Read and Data Store Write
Blocks

This example shows how the code generator removes temporary buffers for Data Store Read and
Data Store Write blocks. This optimization improves execution speed and reduces RAM consumption.

Example Model

The model rtwdemo_optimizedatastorebuffers contains the Function caller UpdateFunc,
which calls the Simulink Function DefineUpdateFunc. The Data Store Read block DSR reads from
mem. The Data Store Write block DSW writes to mem.

model='rtwdemo_optimizedatastorebuffers';
open_system(model);

Generate Code without Optimization

In the Configuration Parameters dialog box, deselect the Reuse buffers for Data Store Read and
Data Store Write blocks parameter or at the MATLAB command prompt, enter this command:

set_param(model,'OptimizeDataStoreBuffers','off');

Build the model.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
slbuild(model)

### Starting build procedure for: rtwdemo_optimizedatastorebuffers
### Successful completion of build procedure for: rtwdemo_optimizedatastorebuffers

Build Summary
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Top model targets built:

Model                             Action                       Rebuild Reason                                    
=================================================================================================================
rtwdemo_optimizedatastorebuffers  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.503s

View the generated code without the optimization. This code is in
rtwdemo_optimizedatastorebuffers.c.

cfile = fullfile(cgDir,'rtwdemo_optimizedatastorebuffers_ert_rtw',...
    'rtwdemo_optimizedatastorebuffers.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void step(void)
{
  real_T rtb_DSR_last;
  real_T rtb_SimFuncCall_o1;
  real_T rtb_Sum_p;

  /* DataStoreRead: '<Root>/DSR' */
  rtb_DSR_last = mem.last;

  /* Switch: '<Root>/Switch' incorporates:
   *  Constant: '<Root>/Constant'
   *  DataStoreRead: '<Root>/DSR'
   *  Inport: '<Root>/Clear'
   */
  if (rtU.Clear) {
    rtb_SimFuncCall_o1 = 0.0;
  } else {
    rtb_SimFuncCall_o1 = mem.max;
  }

  /* End of Switch: '<Root>/Switch' */

  /* FunctionCaller: '<Root>/SimFuncCall' incorporates:
   *  Inport: '<Root>/DataNew'
   */
  UpdateFunc(rtb_SimFuncCall_o1, rtU.DataNew, &rtb_SimFuncCall_o1, &rtb_Sum_p);

  /* DataStoreWrite: '<Root>/DSW' */
  mem.last = rtb_SimFuncCall_o1;
  mem.max = rtb_Sum_p;

  /* Outport: '<Root>/Delta' incorporates:
   *  DataStoreRead: '<Root>/DSR'
   *  Inport: '<Root>/DataNew'
   *  Sum: '<Root>/Sum'
   */
  rtY.Delta = rtU.DataNew - rtb_DSR_last;
}
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The generated code contains data copies for the Data Store Read and Data Store Write blocks,
respectively.

Generate Code with Optimization

In the Configuration Parameters dialog box, clear the Reuse buffers for Data Store Read and
Data Store Write blocks parameter or at the MATLAB command prompt, enter this command:

set_param(model,'OptimizeDataStoreBuffers','on');

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_optimizedatastorebuffers
### Successful completion of build procedure for: rtwdemo_optimizedatastorebuffers

Build Summary

Top model targets built:

Model                             Action                       Rebuild Reason                   
================================================================================================
rtwdemo_optimizedatastorebuffers  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.047s

View the generated code with the optimization. This code is in
rtwdemo_optimizedatastorebuffers.c.

cfile = fullfile(cgDir,'rtwdemo_optimizedatastorebuffers_ert_rtw',...
    'rtwdemo_optimizedatastorebuffers.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void step(void)
{
  real_T rtb_DSR_last;
  real_T tmp;

  /* DataStoreRead: '<Root>/DSR' */
  rtb_DSR_last = mem.last;

  /* Switch: '<Root>/Switch' incorporates:
   *  Constant: '<Root>/Constant'
   *  DataStoreRead: '<Root>/DSR'
   *  Inport: '<Root>/Clear'
   */
  if (rtU.Clear) {
    tmp = 0.0;
  } else {
    tmp = mem.max;
  }

  /* End of Switch: '<Root>/Switch' */
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  /* FunctionCaller: '<Root>/SimFuncCall' incorporates:
   *  DataStoreWrite: '<Root>/DSW'
   *  Inport: '<Root>/DataNew'
   */
  UpdateFunc(tmp, rtU.DataNew, &mem.last, &mem.max);

  /* Outport: '<Root>/Delta' incorporates:
   *  DataStoreRead: '<Root>/DSR'
   *  Inport: '<Root>/DataNew'
   *  Sum: '<Root>/Sum'
   */
  rtY.Delta = rtU.DataNew - rtb_DSR_last;
}

The data copy for the Data Store Write block is not in the generated code. The code contains the data
copy for the Data Store Read block because the Sum block executes after the Data Store Write block.
The generated code contains the variable rtb_DSR_last to hold the output of the Sum block.
Therefore, the Sum block gets the values that SimFuncCall calculates at the start of the time step
rather than those values at the next time step. If the priority of the Sum block is lower than
SimFuncCall, the code generator can remove the data copy for the Data Store Read block. Some
other cases in which the code generator might not eliminate data copies are:

• A Simulink Function internally writes to the Data Store Memory block.
• The Data Store Read or Data Store Write blocks select elements of an array from the Data Store

Memory block.
• The Data Store Memory block has a custom storage class.
• The Data Store Read and Data Store Write blocks occur on the same block unless that block is a

Bus Assignment block or an Assignment block.

Close the model and clean up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Reuse buffers for Data Store Read and Data Store Write blocks”

Related Examples
• “Reuse Local Block Outputs and Generate Code”
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Reduce Data Copies for Bus Assignment Blocks
For models containing a Bus Assignment block, if possible, the code generator uses the same variable
for the block input and output. Reusing these variables reduces data copies, conserves RAM
consumption and increases code execution speed.

Example Model
For example, in bus_assignoptim, a bus signal containing six elements feeds into a Bus Assignment
block and a Bus Selector block. The Bus Assignment block assigns new values to the bus element
a1_real_array. This bus signal feeds into Out1.

Generate Code Without Optimization
Generate code without the optimization by setting the Perform in-place updates for Assignment
and Bus Assignment blocks parameter to off. Without the optimization the
bus_assignoptim_step function contains this code:

void bus_assignoptim_step(void)
{
  real_T rtb_Assignment[36];
  int32_T i;

  /* Assignment: '<Root>/Assignment' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Product: '<Root>/Product'
   *  Selector: '<Root>/Selector'
   *  Sum: '<Root>/Sum1'
   */
  for (i = 0; i < 36; i++) {
    rtb_Assignment[i] = bus_assignoptim_U.In1.a1_real_array[i];
  }

  for (i = 0; i < 2; i++) {
    rtb_Assignment[(int32_T)(i + 22)] = (bus_assignoptim_U.In1.a1_real_array
      [(int32_T)(i + 22)] + bus_assignoptim_U.In1.a1_num) *
      bus_assignoptim_U.In2;
  }

  /* End of Assignment: '<Root>/Assignment' */

  /* Outport: '<Root>/Out' incorporates:
   *  BusAssignment: '<Root>/Bus Assignment'
   *  Inport: '<Root>/In1'
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   */
  bus_assignoptim_Y.Out = bus_assignoptim_U.In1;

  /* BusAssignment: '<Root>/Bus Assignment' incorporates:
   *  Outport: '<Root>/Out'
   */
  for (i = 0; i < 36; i++) {
    bus_assignoptim_Y.Out.a1_real_array[i] = rtb_Assignment[i];
  }
}

The generated code contains the temporary array rtb_Assignment for holding data before this data
is assigned to bus_assignoptim_Y.Out.a1_real_array.

Generate Code with Optimization
Generate code with the optimization by setting the Perform in-place updates for Assignment and
Bus Assignment blocks parameter to on. With the optimization, the bus_assignoptim_step
function contains this code:

/* Model step function */
void bus_assignoptim_step(void)
{
  int32_T i;

  /* Outport: '<Root>/Out' incorporates:
   *  Inport: '<Root>/In1'
   *  SignalConversion: '<Root>/TmpBusAssignmentBufferAtBus AssignmentInport1'
   */
  bus_assignoptim_Y.Out = bus_assignoptim_U.In1;

  /* Assignment: '<Root>/Assignment' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   *  Outport: '<Root>/Out'
   *  Product: '<Root>/Product'
   *  Selector: '<Root>/Selector'
   *  Sum: '<Root>/Sum1'
   */
  for (i = 0; i < 36; i++) {
    bus_assignoptim_Y.Out.a1_real_array[i] =
      bus_assignoptim_U.In1.a1_real_array[i];
  }

  for (i = 0; i < 2; i++) {
    bus_assignoptim_Y.Out.a1_real_array[(int32_T)(i + 22)] =
      (bus_assignoptim_U.In1.a1_real_array[(int32_T)(i + 22)] +
       bus_assignoptim_U.In1.a1_num) * bus_assignoptim_U.In2;
  }

  /* End of Assignment: '<Root>/Assignment' */
}

The generated code does not contain the temporary array rtb_Assignment1 for holding data. The
generated code directly assigns this data to bus_assignoptim_Y.Out.a1_real_array.
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See Also
“Perform in-place updates for Assignment and Bus Assignment blocks”

Related Examples
• “Improve Execution Efficiency by Reordering Block Operations in the Generated Code” on page

72-48
• “Data Copy Reduction”
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Optimize Generated Code by Using Signal Labels to Guide
Buffer Reuse

If your model has the optimal parameter settings for removing data copies, you might be able to
remove additional data copies by using signal labels. After studying the generated code and the Static
Code Metrics Report and identifying areas where you think buffer reuse is possible, you can add
labels to signal lines. If possible, the code generator reorders block operations to implement the
reuse specification.

Specifying buffer reuse improves execution speed and may reduce RAM consumption.

Example Model
The model rtwdemo_label_guided_reuse demonstrates how you can use signal labels to request
buffer reuse for block input and output signals. For this model, the code generator can use the same
variable for the Atomic Subsystem and either the Gain or Saturation block outputs. The generated
code uses the same variable for the Saturation and Atomic Subsystem block outputs because those
signals contain the same label and the Use Signal Labels to Guide Buffer Reuse parameter is
selected.

Generate Code Without Optimization
1 Open the model.

model='rtwdemo_label_guided_reuse';
open_system(model);

2 In the Configuration Parameters dialog box, clear the Use Signal Labels to Guide Buffer
Reuse parameter.

3 Build the model. The rtwdemo_label_guided_reuse_step function contains this code:

void rtwdemo_label_guided_reuse_step(void)
{
  real_T rtb_Saturation[4];
  real_T rtb_Bias[4];
  int32_T i;
  AtomicSubsystem(rtU.In1, rtb_Bias);
  for (i = 0; i < 4; i++) {
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    if (rtb_Bias[i] > 10.0) {
      rtb_Saturation[i] = 10.0;
    } else if (rtb_Bias[i] < -10.0) {
      rtb_Saturation[i] = -10.0;
    } else {
      rtb_Saturation[i] = rtb_Bias[i];
    }

    rtb_Bias[i] *= 3.0;
  }

  AtomicSubsystem1(rtb_Saturation, rtb_Bias, rtY.Out1);
}

By default, within the for loop, the Gain block executes after the Saturation block. The
generated code uses the same variable for the output of the Atomic Subsystem and the Gain
blocks. As a result, the generated code contains two local variables rtb_Saturation and
rtb_Bias for holding intermediate results.

Generate Code with Optimization
In the Configuration Parameters dialog box, select the Use Signal Labels to Guide Buffer Reuse
parameter and build the model. The rtwdemo_label_guided_reuse_step function contains this
code:

void rtwdemo_label_guided_reuse_step(void)
{
  real_T rtb_Gain1[4];
  int32_T i;
  AtomicSubsystem(rtU.In1, rtY.Out1);
  for (i = 0; i < 4; i++) {
    rtb_Gain1[i] = 3.0 * rtY.Out1[i];
    if (rtY.Out1[i] > 10.0) {
      rtY.Out1[i] = 10.0;
    } else {
      if (rtY.Out1[i] < -10.0) {
        rtY.Out1[i] = -10.0;
      }
    }
  }

  AtomicSubsystem1(rtY.Out1, rtb_Gain1, rtY.Out1);
}

The code generator changed the block execution order so that within the for loop, the Saturation
block executes after the Gain block. The generated code contains one local variable rtb_Gain1 for
holding intermediate results.

In addition to requesting which buffers to reuse, another possible use case is to request buffer reuse
for block input and output signals that are complex.

Using Label-Based Reuse Versus Reusable Custom Storage Classes
You can also use the same Reusable custom storage class specification on different signal lines to
specify which buffers to reuse. As compared to using Reusable custom storage classes, using signal
labels to specify reuse has these benefits:
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• Signal labels are not observation points in the generated code, so using them does not block other
optimizations such as dead code elimination and expression folding.

• The code generator does not force a signal with a label to be a global variable in the generated
code. The signal can be a local or global variable.

• Signals with labels can reuse buffers with signals that do not have labels, so reuse among local
and global variables is possible.

Using signal labels is a more conservative method of specifying reuse than using Reusable custom
storage classes. The code generator does not implement label-based reuse when it can implement
reuse by using Reusable custom storage classes in these cases:

• Reuse that can potentially prevent other optimizations from occurring in the generated code.
• Reuse on root inport and outport ports.
• Reuse across model reference or subsystem boundaries.
• Within a subsystem, buffer reuse on an intermediary signal and an input or output port.

See Also
“Use signal labels to guide buffer reuse”

Related Examples
• “Improve Execution Efficiency by Reordering Block Operations in the Generated Code” on page

72-48
• “Remove Data Copies by Reordering Block Operations in the Generated Code” on page 71-25
• “Specify Buffer Reuse by Using Simulink.Signal Objects” on page 71-17
• “Data Copy Reduction”

 Optimize Generated Code by Using Signal Labels to Guide Buffer Reuse

71-39





Execution Speed in Embedded Coder

• “Reduce Memory Usage for Signals” on page 72-2
• “Remove Zero Initialization Code” on page 72-3
• “Simplify Multiply Operations in Array Indexing” on page 72-8
• “Replace boolean with Specific Integer Data Type” on page 72-11
• “Remove Code from Tunable Parameter Expressions That Saturate Against Integer Overflow”

on page 72-14
• “Remove Code That Guards Against Division Exceptions for Integers and Fixed-Point Data”

on page 72-17
• “Optimize Generated Code by Consolidating Redundant If-Else Statements” on page 72-21
• “Optimize Generated Code for Fixed-Point Data Operations” on page 72-25
• “Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®”

on page 72-27
• “Improve Execution Efficiency by Reordering Block Operations in the Generated Code”

on page 72-48
• “Generate SIMD Code from Simulink Blocks” on page 72-58
• “Speed Up for-Loop Implementation in Code Generated by Using parfor” on page 72-62
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Reduce Memory Usage for Signals
The configuration parameter Signal storage reuse reduces the memory requirements of your real-
time program by enabling parameters that reuse the memory allocated for signals with an auto
storage class. These parameters are the following:

• Enable local block outputs
• Reuse local block outputs
• Reuse global block outputs
• Optimize global data access

When the Enable local block outputs parameter is on, where possible the code generator declares
block outputs as local variables instead of global variables. Replacing global variables with local
variables improves execution speed and reduces RAM/ROM consumption. Creating more local
variables can increase stack usage. Some of the global variables that the code generator can localize
include:

• Global signals that cross subsystem boundaries
• Global signals across Simulink and Stateflow domains
• Unused global state variables
• Redundant local Data Store Memory block signals

When the Reuse local block outputs parameter is on, wherever possible the code generator reuses
local (function) variables for block outputs. When you select Reuse global block outputs, the code
generator reuses global (function) variables wherever possible.

The Optimize global data access parameter has these settings:

• None
• Use global to hold temporary results
• Minimize global data access

When you select None, the code generator uses the default optimizations. The setting Use global
to hold temporary results maximizes the use of global variables. The setting Minimize
global data access minimizes the use of global variables by using local variables to hold
intermediate values.

Clearing Signal storage reuse makes all block outputs global and unique, which often significantly
increases RAM and ROM usage.

The code generator does not localize global variables for MATLAB system objects or AUTOSAR.

See Also

Related Examples
• “Enable and Reuse Local Block Outputs in Generated Code”
• “Reuse Global Block Outputs in the Generated Code” on page 71-12
• “Optimize Global Variable Usage” on page 71-2
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Remove Zero Initialization Code
The “Remove root level I/O zero initialization” and “Remove internal data zero initialization”
parameters control whether the generated code contains initialization code for internal data (block
states and block outputs) and external data (root inports and outports) whose value is zero.
Eliminating zero initialization code accelerates model initialization, reduces ROM consumption, and
increases the execution speed of the generated code.

During startup, standards-compliant C and C++ compilers initialize global data to zero eliminating
the need to include zero initialization code for this data in the generated code. Standards-compliant
compilers do not necessarily initialize dynamically allocated data and local variables to zero. Before
leaving the Remove root level I/O zero initialization and Remove internal data zero
initialization parameters selected, confirm the following:

• If your compiler is not standards compliant, confirm that it initializes global data to zero.
• If you set the “Code interface packaging” to Reusable function or C++ class, confirm that

data is either statically allocated or that dynamically allocated data is initialized to zero.

If you set the Code interface packaging parameter to Reusable function and select the “Use
dynamic memory allocation for model initialization” parameter, the Remove root level I/O zero
initialization and Remove internal data zero initialization check boxes are cleared and at the
command line, ZeroExternalMemoryAtStartup and ZeroInternalMemoryAtStartup
parameters are set to 'on'.

For a model in which the Code interface packaging parameter is set to C++ class and the “Use
dynamic memory allocation for model block instantiation” parameter is selected, the Remove
internal data zero initialization check box is cleared and ZeroInternalMemoryAtStartup is set
to 'on' and is read-only .

Remove Zero Initialization Code for Internal Data
This example shows how to eliminate code that initializes internal data to zero.

Example Model

Open the model rtwdemo_internal_init. The model contains an enabled subsystem whose initial
output is zero. The subsystem contains a Unit Delay block whose initial condition is 0.

model = 'rtwdemo_internal_init';
open_system(model);
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Generate Code Without Optimization

Build the model by using Embedded Coder.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
evalc('slbuild(model)');

This code is in the rtwdemo_internal_init.c file.

cfile = fullfile(cgDir,'rtwdemo_internal_init_ert_rtw','rtwdemo_internal_init.c');
rtwdemodbtype(cfile,'/* Model initialize', '* File trailer', 1, 0);

/* Model initialize function */
void rtwdemo_internal_init_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtM, (NULL));

  /* states (dwork) */
  (void) memset((void *)&rtDWork, 0,
                sizeof(D_Work));

  /* SystemInitialize for Enabled SubSystem: '<Root>/Enabled Subsystem' */
  /* InitializeConditions for UnitDelay: '<S1>/Unit Delay' */
  rtDWork.UnitDelay_DSTATE = 0.0;

  /* End of SystemInitialize for SubSystem: '<Root>/Enabled Subsystem' */
}

/*

Enable Optimization

Open the Configuration Parameters dialog box. On the Optimization pane, select Remove internal
data zero initialization.

Alternatively, you can use the command prompt to enable the optimization. Set the model parameter
ZeroInternalMemoryAtStartup to 'off'.

set_param(model, 'ZeroInternalMemoryAtStartup', 'off');

set_param(model, 'ZeroInternalMemoryAtStartup', 'off');

Generate Code with Optimization

Build the model by using Embedded Coder.

evalc('slbuild(model)');

This code is in the rtwdemo_internal_init.c file. The generated code does not initialize internal
data by assignment to zero.

rtwdemodbtype(cfile,'/* Model initialize', '* File trailer', 1, 0);

/* Model initialize function */
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void rtwdemo_internal_init_initialize(void)
{
  /* (no initialization code required) */
}

/*

bdclose(model)
rtwdemoclean;
cd(currentDir)

Remove Initialization Code from Root-Level Inports and Outports Set
to Zero
This example shows how to remove initialization code from root-level inports and outports set to zero.

Example Model

In the model rtwdemo_rootlevel_zero_initialization, all of the input and output signals have a numeric
value of zero. Because signals sig1 and sig2 have data types int16 and Boolean, respectively, and
all of the output signals have data type double, these signals also have initial values of bitwise zero.
The signals have an integer bit pattern of 0, meaning that all bits are off. Signals sig1_b and sig2_b
have a fixed-point data type with bias, so their initial value is not bitwise zero.

model = 'rtwdemo_rootlevel_zero_initialization';
open_system(model);

Generate Code

In your system temporary folder, create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model by using Embedded Coder.

set_param(model, 'ZeroExternalMemoryAtStartup','on');
evalc('slbuild(model)');

These lines of rtwdemo_rootlevel_zero_initialization.c code show the initialization of root-
level inports and outports without the optimization. The four input signals are individually initialized
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as global variables. The four output signals are members of a global structure that the memset
function initializes to bitwise zero.

cfile = fullfile(cgDir,'rtwdemo_rootlevel_zero_initialization_ert_rtw',...
    'rtwdemo_rootlevel_zero_initialization.c');
rtwdemodbtype(cfile, 'rtwdemo_rootlevel_zero_initialization_initialize',...
    'trailer for generated code', 1, 0);

void rtwdemo_rootlevel_zero_initialization_initialize(void)
{
  /* Registration code */

  /* external inputs */
  sig1 = 0;
  sig1_b = -3;
  sig2 = false;
  sig2_b = -3;

  /* external outputs */
  (void) memset((void *)&rtY, 0,
                sizeof(ExternalOutputs));
}

/*

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, select Remove root level I/O zero initialization.

Alternatively, use the command-line API to enable the optimization:

 set_param(model, 'ZeroExternalMemoryAtStartup','off');

Generate Code with Optimization

The optimized code does not contain initialization code for the input signals sig1, sig2, and the four
output signals because their initial values are bitwise zero.

Build the model.

evalc('slbuild(model)');

Here is the rtwdemo_rootlevel_zero_initialization.c optimized code in the initialization
function.

cfile = fullfile(cgDir,'rtwdemo_rootlevel_zero_initialization_ert_rtw',...
    'rtwdemo_rootlevel_zero_initialization.c');
rtwdemodbtype(cfile, 'rtwdemo_rootlevel_zero_initialization_initialize',...
    'trailer for generated code', 1, 0);

void rtwdemo_rootlevel_zero_initialization_initialize(void)
{
  /* Registration code */

  /* external inputs */
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  sig1_b = -3;
  sig2_b = -3;
}

/*

Close the model and the code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Additional Information
• You can use the Use memset to initialize floats and doubles parameter to control the

representation of zero during initialization. See “Use memset to initialize floats and doubles to
0.0”.

• The code still initializes data structures whose value is not zero when you select the Remove
internal data zero initialization and Remove root level I/O zero initialization parameters.

• The data of ImportedExtern or ImportedExternPointer storage classes are not initialized,
regardless of the settings of the Remove internal data zero initialization and Remove root
level I/O zero initialization parameters.

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Optimize Generated Code Using memset Function” on page 69-93

 Remove Zero Initialization Code

72-7



Simplify Multiply Operations in Array Indexing
In this section...
“Example Model” on page 72-8
“Generate Code” on page 72-8
“Generate Code with Optimization” on page 72-9

The generated code might have multiply operations when indexing an element of an array. You can
select the optimization parameter “Simplify array indexing” to replace multiply operations in the
array index with a temporary variable. This optimization can improve execution speed by reducing
the number of times the multiply operation executes.

Example Model
If you have the following model:

The Constant blocks have the following Constant value:

• Const1: reshape(1:30,[1 5 3 2])
• Const2: reshape(1:20,[1 5 2 2])
• Const3: reshape(1:90,[1 5 9 2])

The Concatenate block parameter Mode is set to Multidimensional array. The Constant blocks
Sample time parameter is set to –1.

Generate Code
Building the model with the Simplify array indexing parameter turned off generates the following
code:

int32_T i;
int32_T i_0;
int32_T i_1;

for (i = 0; i < 2; i++) {
  for (i_1 = 0; i_1 < 3; i_1++) {
    for (i_0 = 0; i_0 < 5; i_0++) {
      ex_arrayindex_Y.Out[(i_0 + 5 * i_1) + 70 * i] =
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        ex_arrayindex_P.Constant1_Value[(5 * i_1 + i_0) + 15 * i];
    }
  }
}

for (i = 0; i < 2; i++) {
  for (i_1 = 0; i_1 < 2; i_1++) {
    for (i_0 = 0; i_0 < 5; i_0++) {
      ex_arrayindex_Y.Out[(i_0 + 5 * (i_1 + 3)) + 70 * i] =
        ex_arrayindex_P.Constant2_Value[(5 * i_1 + i_0) + 10 * i];
    }
  }
}

for (i = 0; i < 2; i++) {
  for (i_1 = 0; i_1 < 9; i_1++) {
    for (i_0 = 0; i_0 < 5; i_0++) {
      ex_arrayindex_Y.Out[(i_0 + 5 * (i_1 + 5)) + 70 * i] =
        ex_arrayindex_P.Constant3_Value[(5 * i_1 + i_0) + 45 * i];
    }
  }
}

Generate Code with Optimization
Open the Configuration Parameters dialog box and select the Simplify array indexing parameter.
Build the model again. In the generated code, [(i_0 + tmp_1) + tmp] replaces a multiply
operation in the array index, [(i_0 + 5 * i_1) + 70 * i]. The generated code is now:

int32_T i;
int32_T i_0;
int32_T i_1;
int32_T tmp;
int32_T tmp_0;
int32_T tmp_1;

tmp = 0;
tmp_0 = 0;
for (i = 0; i < 2; i++) {
  tmp_1 = 0;
  for (i_1 = 0; i_1 < 3; i_1++) {
    for (i_0 = 0; i_0 < 5; i_0++) {
      ex_arrayindex_Y.Out[(i_0 + tmp_1) + tmp] =
        ex_arrayindex_P.Constant1_Value[(i_0 + tmp_1) + tmp_0];
    }

    tmp_1 += 5;
  }

  tmp += 70;
  tmp_0 += 15;
}

tmp = 0;
tmp_0 = 0;
for (i = 0; i < 2; i++) {
  tmp_1 = 0;
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  for (i_1 = 0; i_1 < 2; i_1++) {
    for (i_0 = 0; i_0 < 5; i_0++) {
      ex_arrayindex_Y.Out[((i_0 + tmp_1) + tmp) + 15] =
        ex_arrayindex_P.Constant2_Value[(i_0 + tmp_1) + tmp_0];
    }

    tmp_1 += 5;
  }

  tmp += 70;
  tmp_0 += 10;
}

tmp = 0;
tmp_0 = 0;
for (i = 0; i < 2; i++) {
  tmp_1 = 0;
  for (i_1 = 0; i_1 < 9; i_1++) {
    for (i_0 = 0; i_0 < 5; i_0++) {
      ex_arrayindex_Y.Out[((i_0 + tmp_1) + tmp) + 25] =
        ex_arrayindex_P.Constant3_Value[(i_0 + tmp_1) + tmp_0];
    }

    tmp_1 += 5;
  }

  tmp += 70;
  tmp_0 += 45;
}

See Also
“Simplify array indexing”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 69-48
• “Vector Operation Optimization” on page 69-97
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Replace boolean with Specific Integer Data Type
Depending on the architecture of the processor that your production hardware uses, you can improve
the execution speed of the generated code. Select a specific integer data type for the built-in type
boolean. Using data type replacement, in the generated code you can replace the boolean built-in
data type with one of these integer types:

• int8
• uint8
• intn

To match the integer word size for the production hardware, replace n with 8, 16, or 32 .

Example Model
The model ex_bool contains two blocks that output boolean values and two blocks that take
boolean values as inputs. This example shows how to replace the data type boolean with the
integer data type int32 in the code generated for a 32-bit hardware target.

Generate Code That Contains the Default boolean Data Type
View the generated file rtwtypes.h. The typdef statements contain the generic type definition of
boolean_T, which is the code generation name for boolean.

/*===========================================================================*
 * Generic type definitions: boolean_T, char_T, byte_T, int_T, uint_T,       *
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 *                           real_T, time_T, ulong_T.                        *
 *===========================================================================*/
typedef double real_T;
typedef double time_T;
typedef unsigned char boolean_T;
typedef int int_T;
typedef unsigned int uint_T;
typedef unsigned long ulong_T;
typedef char char_T;
typedef unsigned char uchar_T;
typedef char_T byte_T;

View the generated file ex_bool.c. The code declares boolean variables by using the type
boolean_T.

/* External inputs (root inport signals with auto storage) */
typedef struct {
  real_T In1;                          /* '<Root>/In1' */
  real_T In2;                          /* '<Root>/In2' */
  boolean_T In3;                       /* '<Root>/In3' */
  boolean_T In4;                       /* '<Root>/In4' */
  real_T In5;                          /* '<Root>/In5' */
} ExtU_ex_bool_T;

/* External outputs (root outports fed by signals with auto storage) */
typedef struct {
  boolean_T Out1;                      /* '<Root>/Out1' */
  boolean_T Out2;                      /* '<Root>/Out2' */
  real_T Out3;                         /* '<Root>/Out3' */
} ExtY_ex_bool_T;

Generate Code That Contains the Target boolean Data Type
1 Define a Simulink.AliasType object with a base type of int32. Name the object using the

replacement name that you want to appear in the generated code.

mybool = Simulink.AliasType;
mybool.BaseType = 'int32';

2 In the Configuration Parameters dialog box, specify the Replacement Name field for the data
type boolean as mybool.
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View the generated file rtwtypes.h. The code maps the identifier mybool to the native integer type
of the target hardware by creating typedef statements.

/* Generic type definitions ... */
...
typedef int boolean_T;
 ...
/* Define Simulink Coder replacement data types. */
typedef boolean_T mybool;    /* User defined replacement datatype for boolean_T */

View the generated file ex_bool.c. The code declares boolean variables that use the type mybool.

  /* External inputs (root inport signals with auto storage) */
typedef struct {
  real_T In1;                          /* '<Root>/In1' */
  real_T In2;                          /* '<Root>/In2' */
  mybool In3;                          /* '<Root>/In3' */
  mybool In4;                          /* '<Root>/In4' */
  real_T In5;                          /* '<Root>/In5' */
} ExtU_ex_bool_T;

/* External outputs (root outports fed by signals with auto storage) */
typedef struct {
  mybool Out1;                         /* '<Root>/Out1' */
  mybool Out2;                         /* '<Root>/Out2' */
  real_T Out3;                         /* '<Root>/Out3' */
} ExtY_ex_bool_T;

See Also
Simulink.AliasType

Related Examples
• “Model Configuration Parameters: Code Generation Data Type Replacement”
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Remove Code from Tunable Parameter Expressions That
Saturate Against Integer Overflow

Optimize generated code by removing code that protects parameter expressions from integer
overflow for integers and fixed-point data. If you are sure that you will not tune the terms of tunable
parameter expressions to cause them to evaluate to a value that is below or above the representable
value of a data type, enable this optimization.This optimization increases execution speed and results
in smaller code that reduces ROM consumption.

Risks

When you select the EfficientTunableParamExpr parameter, and you tune the terms of the
expression so that it encounters an integer overflow, the result will wrap around in the generated
code. This behavior can cause the application to behave unexpectedly at run-time.

NOTE: If you enable this optimization, it is possible that simulation results and results from
generated code are not in bit-for-bit agreement. This example requires Embedded Coder®.

Example Model

In the model matlab:mEfficientParamExpr, an input signal of type int8 feeds into a Gain block.

model = 'mEfficientParamExpr';
open_system(model);

Generate Code

In your system temporary folder, create another temporary folder for the build and inspection
process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

set_param(model, 'EfficientTunableParamExpr', 'off');
evalc('slbuild(model)');

View the generated code without the optimization. Here is a portion of mEfficientParamExpr.c.

cfile = fullfile(cgDir,'mEfficientParamExpr_ert_rtw','mEfficientParamExpr.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void mEfficientParamExpr_step(void)
{
  int32_T tmp;

  /* Gain: '<Root>/Gain' */
  tmp = P + Q;
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  if (tmp > 127) {
    tmp = 127;
  } else if (tmp < -128) {
    tmp = -128;
  }

  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/In1'
   */
  rtY.Out1 = (int8_T)(tmp * rtU.In1);
}

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, select Remove code from tunable parameter expressions that

saturates out-of-range values.

Alternatively, use the command-line API to enable the optimization:

set_param(model, 'EfficientTunableParamExpr', 'on');

Generate Code with Optimization

The optimized code does not contain code that checks the bounds of the representable value of a data
type.

Build the model.

evalc('slbuild(model)');

The following is a portion of mEfficientParamExpr.c. The code that protects against expression
overflow is not in the generated code.

rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void mEfficientParamExpr_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/In1'
   */
  rtY.Out1 = (int8_T)((int8_T)(P + Q) * rtU.In1);
}

Close the model and code generation report.
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bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also

Related Examples
• “Check configuration parameters for generation of inefficient saturation code”
• “Remove Code from Tunable Parameter Expressions That Saturate Out-of-Range Values”
• “Optimization Tools and Techniques” on page 69-7
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Remove Code That Guards Against Division Exceptions for
Integers and Fixed-Point Data

Optimize generated code by removing code that protects against division by zero and overflows in
division INT_MIN/-1 operations for integers and fixed-point data. If you are sure that these
arithmetic exceptions do not occur during program execution, enable this optimization but it may
lead to a quotient that cannot be represented.

This optimization:

• Increases execution speed.
• Results in smaller code thereby reducing ROM consumption.

Risks

When you select the NoFixptDivByZeroProtection parameter, the code generator removes code
that protects against the following errors:

• When you divide by zero it is undefined and results in a runtime error in the generated code.
• When you divide the minimum representable value of a signed integer by negative one, the ideal

result is equal to the maximum representable value plus one (INT_MAX + 1), which is not
representable. This exception may cause the application to unexpectedly halt or crash at run-time.

NOTE: If you enable this optimization, it is possible that simulation results and results from
generated code are not in bit-for-bit agreement. This example requires an Embedded Coder® license.

Example Model

In the model rtwdemo_nzcheck, two signals of type int8 feed into a divide block.

model = 'rtwdemo_nzcheck';
open_system(model);

Generate Code

In your system's temporary folder, create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.
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set_param(model, 'NoFixptDivByZeroProtection', 'off');
slbuild(model);

### Starting build procedure for: rtwdemo_nzcheck
### Successful completion of code generation for: rtwdemo_nzcheck

Build Summary

Top model targets built:

Model            Action          Rebuild Reason                                    
===================================================================================
rtwdemo_nzcheck  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 8.214s

View the generated code without the optimization. Here is a portion of rtwdemo_nzcheck.c.

cfile = fullfile(cgDir,'rtwdemo_nzcheck_ert_rtw','rtwdemo_nzcheck.c');
rtwdemodbtype(cfile,'/* Real-time model','/* Model initialize function',1, 1);

/* Real-time model */
static RT_MODEL_rtwdemo_nzcheck rtwdemo_nzcheck_M_;
RT_MODEL_rtwdemo_nzcheck *const rtwdemo_nzcheck_M = &rtwdemo_nzcheck_M_;
int32_T div_s32(int32_T numerator, int32_T denominator)
{
  int32_T quotient;
  uint32_T tempAbsQuotient;
  if (denominator == 0) {
    quotient = numerator >= 0 ? MAX_int32_T : MIN_int32_T;

    /* Divide by zero handler */
  } else {
    tempAbsQuotient = (numerator < 0 ? ~(uint32_T)numerator + 1U : (uint32_T)
                       numerator) / (denominator < 0 ? ~(uint32_T)denominator +
      1U : (uint32_T)denominator);
    quotient = (numerator < 0) != (denominator < 0) ? -(int32_T)tempAbsQuotient :
      (int32_T)tempAbsQuotient;
  }

  return quotient;
}

/* Model step function */
void rtwdemo_nzcheck_step(void)
{
  /* Product: '<Root>/Divide' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   */
  Y = div_s32(U1, U2);
}
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Enable Optimization
1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, select Remove code that protects against division arithmetic

exceptions.

Alternatively, you may use the command-line API to enable the optimization:

set_param(model, 'NoFixptDivByZeroProtection', 'on');

Generate Code with Optimization

The optimized code does not contain code that checks for whether or not the divisor has a value of
zero.

Build the model.

slbuild(model);

### Starting build procedure for: rtwdemo_nzcheck
### Successful completion of code generation for: rtwdemo_nzcheck

Build Summary

Top model targets built:

Model            Action          Rebuild Reason                   
==================================================================
rtwdemo_nzcheck  Code generated  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 8.619s

The following is a portion of rtwdemo_nzcheck.c. The code that protects against division arithmetic
exceptions is not in the generated code.

rtwdemodbtype(cfile,'/* Real-time model','/* Model initialize function',1, 1);

/* Real-time model */
static RT_MODEL_rtwdemo_nzcheck rtwdemo_nzcheck_M_;
RT_MODEL_rtwdemo_nzcheck *const rtwdemo_nzcheck_M = &rtwdemo_nzcheck_M_;

/* Model step function */
void rtwdemo_nzcheck_step(void)
{
  /* Product: '<Root>/Divide' incorporates:
   *  Inport: '<Root>/In1'
   *  Inport: '<Root>/In2'
   */
  Y = U1 / U2;
}

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)
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Additional Information

There are several other factors that can affect the appearance of the generated code for division
operations. The generated code for blocks containing MATLAB® code with integer or fixed-point
division operations differs from the built-in Divide block in Simulink®. To balance the efficiency and
semantics of fixed-point and integer divisions in these blocks, use fi objects and set the fimath
properties to fit your needs and requires a Fixed-Point Designer™ license. Rounding and overflow
modes also affect the size and efficiency of the generated code.

See Also
“Remove code that protects against division arithmetic exceptions”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values” on

page 69-20
• “Remove Code That Maps NaN to Integer Zero” on page 69-23
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Optimize Generated Code by Consolidating Redundant If-Else
Statements

This example shows how to optimize generated code by combining if-else statements that share
the same condition. This optimization:

• Improves control flow.
• Reduces code size.
• Reduces RAM consumption.
• Increases execution speed.

Example

The model rtwdemo_controlflow_opt contains three Switch blocks. The Constant block provides the
control input to the Switch blocks. The variable named Cond determines the value of the Constant
block.

model = 'rtwdemo_controlflow_opt';
open_system(model);

Generate Code

Create a temporary folder for the build and inspection process.
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currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_controlflow_opt
### Successful completion of build procedure for: rtwdemo_controlflow_opt

Build Summary

Top model targets built:

Model                    Action                       Rebuild Reason                                    
========================================================================================================
rtwdemo_controlflow_opt  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.552s

These lines of rtwdemo_controlflow_opt.c code show that in the generated code, two if-else
statements and one else-if statement represent the three Switch blocks.

cfile = fullfile(cgDir,'rtwdemo_controlflow_opt_ert_rtw',...
    'rtwdemo_controlflow_opt.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_controlflow_opt_step(void)
{
  /* Switch: '<Root>/Switch3' incorporates:
   *  Constant: '<Root>/Const'
   *  Switch: '<Root>/Switch2'
   */
  if (Cond) {
    /* Switch: '<Root>/Switch1' */
    if (Cond) {
      /* Outport: '<Root>/Out1' incorporates:
       *  Inport: '<Root>/In1'
       */
      rtY.Out1 = rtU.In1;
    } else {
      /* Outport: '<Root>/Out1' incorporates:
       *  Inport: '<Root>/In2'
       */
      rtY.Out1 = rtU.In2;
    }

    /* End of Switch: '<Root>/Switch1' */
  } else if (Cond) {
    /* Switch: '<Root>/Switch2' incorporates:
     *  Inport: '<Root>/In1'
     *  Outport: '<Root>/Out1'
     */
    rtY.Out1 = rtU.In1;
  } else {
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    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/In2'
     */
    rtY.Out1 = rtU.In2;
  }

  /* End of Switch: '<Root>/Switch3' */
}

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Code generation-> Code Style pane, clear Preserve condition expression in if

statement. This parameter is on by default.

Alternatively, use the command-line API to turn off the parameter:

set_param(model, 'PreserveIfCondition', 'off');

Generate Code with Optimization

In the optimized code, the code generator consolidates the two if-else statements and one else-
if statement into one if-else statement. The code generator consolidates these statements
because they all share the same condition. There is no intervening code that affects the outcomes of
these statements.

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_controlflow_opt
### Successful completion of build procedure for: rtwdemo_controlflow_opt

Build Summary

Top model targets built:

Model                    Action                       Rebuild Reason                   
=======================================================================================
rtwdemo_controlflow_opt  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.285s

Here is the rtwdemo_controlflow_opt.c optimized code.

rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_controlflow_opt_step(void)
{
  /* Switch: '<Root>/Switch1' incorporates:
   *  Constant: '<Root>/Const'
   *  Switch: '<Root>/Switch3'
   */
  if (Cond) {
    /* Outport: '<Root>/Out1' incorporates:
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     *  Inport: '<Root>/In1'
     */
    rtY.Out1 = rtU.In1;
  } else {
    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/In2'
     */
    rtY.Out1 = rtU.In2;
  }

  /* End of Switch: '<Root>/Switch1' */
}

Close the model and clean up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Preserve condition expression in if statement”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Eliminate Dead Code Paths in Generated Code” on page 69-55
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Optimize Generated Code for Fixed-Point Data Operations
This example shows how the code generator optimizes fixed-point operations by replacing expensive
division operations with highly efficient product operations. This optimization improves execution
speed.

Example Model

In the model rtwdemo_fixptdiv, two fixed point signals connect to a Divide block. The Number of
inputs parameter has the value /*.

model='rtwdemo_fixptdiv';
load_system(model)
set_param(model,'HideAutomaticNames','off','SimulationCommand','Update')
open_system(model);

Generate Code

Create a temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

set_param(model,'GenCodeOnly','on');
slbuild(model);

### Starting build procedure for: rtwdemo_fixptdiv
### Successful completion of code generation for: rtwdemo_fixptdiv

Build Summary

Top model targets built:
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Model             Action          Rebuild Reason                                    
====================================================================================
rtwdemo_fixptdiv  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 10.755s

View the generated code. Here is a portion of rtwdemo_fixptdiv.c.

cfile = fullfile(cgDir,'rtwdemo_fixptdiv_ert_rtw','rtwdemo_fixptdiv.c');
rtwdemodbtype(cfile,'/* Model step','/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_fixptdiv_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/In1'
   *  Product: '<Root>/Divide'
   */
  rtY.Out1 = (int16_T)(rtU.In1 >> 3);
}

The generated code contains a highly efficient right shift operation instead of an expensive division
operation. The generated code also contains the precomputed value for the constant input to the
Product block.

Note that the resulting operation also includes the adjustment in signal scaling from 2^-3 to 2^-5.

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Fixed Point”

72 Execution Speed in Embedded Coder

72-26



Optimize Generated Code By Developing and Using Code
Replacement Libraries - Simulink®

Develop and use code replacement libraries to replace function and operators in generated code.
Code replacement is a technique to change the code that the code generator produces for functions
and operators to meet application code requirements. For example, you can replace generated code
to meet requirements such as:

• Optimization for a specific run-time environment, including, but not limited to, specific target
hardware

• Integration with existing application code
• Compliance with a standard, such as AUTOSAR
• Modification of code behavior, such as enabling or disabling nonfinite or inline support
• Application- or project-specific code requirements, such as use of BLAS or elimination of math.h,

system header files, or calls to memcpy or memset.

You can configure a model such that the code generator uses a code replacement library that
MathWorks® provides. If you have an Embedded Coder® license, you can develop your own code
replacement library interactively with the Code Replacement Tool or programmatically.

This example uses models to show a variety of ways you can define code replacement mappings
programmatically. Each model includes buttons that you can use to

• View the code replacement library table definitions from the Code Replacement Viewer
• Open the library table definition file in the editor
• Open the library registration file in the editor
• View the model configuration
• Generate code

For more information, see “Define Code Replacement Library Optimizations” on page 67-36 and
“Register Code Replacement Library” on page 67-51.

Steps for Developing a Code Replacement Library

1 Identify your code replacement requirements with respect to function or operating mappings,
build information, and registration information.

2 Prepare for code replacement library development (for example, identify or develop models to
test your library).

3 Define code replacement mappings.
4 Specify build information for replacement code.
5 Register code replacement mappings.
6 Verify code replacements.
7 Deploy the library.

For more information, see “Quick Start Code Replacement Library Development - Simulink®” on
page 67-21.
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Math Function Replacement

This example defines and registers code replacement mappings for math functions. You can define
code replacement mappings for a variety of functions (see “Code You Can Replace From Simulink
Models” on page 67-6).

Open the model rtwdemo_crlmath and use the buttons at the bottom of the model window to
explore the files that define and register the code replacement library mappings.

For more information, see “Math Function Code Replacement” on page 67-64.

open_system('rtwdemo_crlmath')
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Addition and Subtraction Operator Replacement

This example shows how to define and register code replacement mappings for addition (+) and
subtraction (-) operations. When defining entries for addition and subtraction operations, you can
specify which of the following algorithms (EntryInfoAlgorithm) your library functions implement:

• Cast-before-operation (CBO) (RTW_CAST_BEFORE_OP), the default
• Cast-after-operation (CAO) (RTW_CAST_AFTER_OP)
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1. Open the model rtwdemo_crladdsub. The model shows how to define and register code
replacement mappings for scalar addition subtraction (-) operations on two operands with the
following pairings of built-in integer data types:

• int8, uint8
• int16, uint16
• int32, uint32

CBO, the default algorithm, is assumed.

open_system('rtwdemo_crladdsub')
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2. Use the buttons at the bottom of the model window to explore the files that define and register the
code replacement library mappings.

3. Explore the differences between the CBO and CAO algorithms by opening the model
rtwdemo_crl_cbo_cao. The model shows two SUM blocks, each demonstrating one of the
algorithm settings to match a corresponding code replacement entry.

• For the Cast_before_operation_Sub block, the code generator calculates the subtraction
operation in the accumulator data type (int8), which is smaller than the input data type (int16).
This is equivalent to a CBO because the code generator converts the input to the output data type
before calculating the result.

• For the Cast_after_operation_Sub block, the code generator calculates the subtraction
operation in the accumulator data type (int32), which is larger than the input data type (int16).
This is equivalent to a CAO because the code generator produces the same result by calculating
the result without loss of range or precision before converting to the output data type.

open_system('rtwdemo_crl_cbo_cao')
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4. Use the buttons at the bottom of the model window to explore the files that define and register the
code replacement library mappings.

For more information on addition and subtraction operator replacement, see “Addition and
Subtraction Operator Code Replacement” on page 67-134. For more information on the addition and
subtraction algorithm (EntryInfoAlgorithm) options, see setTflCOperationEntryParameters.

Multiplication and Division Operator Replacement for Built-In Integers

This example defines and registers code replacement mappings for scalar multiplication (*) and
division (/) operations. The operations take two operands with the following pairings of built-in
integer data types:

• int8, uint8
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• int16, uint16
• int32, uint32

Open the model rtwdemo_crlmuldiv and use the buttons at the bottom of the model window to
explore the files that define and register the code replacement library mappings.

open_system('rtwdemo_crlmuldiv')

Scalar Operator Replacement

This example defines and registers code replacement mappings for scalar operations: addition,
subtraction, multiplication, complex conjugate, cast, arithmetic shift right, and arithmetic shift left.

Supported types include:
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• single, double
• int8, uint8
• int16, uint16
• int32, uint32
• csingle, cdouble
• cint8, cuint8
• cint16, cuint16
• cint32, cuint32
• fixed-point integers
• mixed types (different type on each input)

Open the model rtwdemo_crlscalarops and use the buttons at the bottom of the model window to
explore the files that define and register the code replacement library mappings.

For more information on scalar operator replacement, “Scalar Operator Code Replacement” on page
67-129.

CBO, the default algorithm for addition and subtraction operations, is assumed.

open_system('rtwdemo_crlscalarops')
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Matrix Operator Replacement

This example defines and registers code replacement mappings for matrix operations: addition,
subtraction, multiplication, transposition, conjugate, and Hermitian.

Supported types include:

• single, double
• int8, uint8
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• int16, uint16
• int32, uint32
• csingle, cdouble
• cint8, cuint8
• cint16, cuint16
• cint32, cuint32
• fixed-point integers
• mixed types (different type on each input)

Open the model rtwdemo_crlmatops, which shows some of these replacements. Use the buttons at
the bottom of the model window to explore the files that define and register the code replacement
library mappings.

For more information on matrix operator replacement, see “Small Matrix Operation to Processor
Code Replacement” on page 67-158.

CBO, the default algorithm for addition and subtraction operations, is assumed.

open_system('rtwdemo_crlmatops')

72 Execution Speed in Embedded Coder

72-36



 Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®

72-37



Matrix Multiplication Replacement for BLAS

This example defines and registers code replacement mappings for Basic Linear Algebra Subroutines
(BLAS) subroutines xGEMM and xGEMV. You can map the following operations to a BLAS subroutine:

• Matrix multiplication
• Matrix multiplication with transpose on single or both inputs
• Matrix multiplication with Hermitian operation on single or both inputs

Open the model rtwdemo_crlblas and use the buttons at the bottom of the model window to
explore the files that define and register the code replacement library mappings.

For more information on matrix multiplication replacement for BLAS, see “Matrix Multiplication
Operation to MathWorks BLAS Code Replacement” on page 67-141.

open_system('rtwdemo_crlblas')
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Fixed-Point Operator Replacement for Basic Operators

This example defines and registers code replacement mappings for scalar addition (+), subtraction
(-), multiplication (*), and division (/) operations. The operations take two operands with fixed-point
data types.

You can define code replacements as matching:

• Slope/bias scaling combination on the inputs and output
• Binary-point scaling combination on the inputs and output
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• Relative scaling between the inputs and output
• Same slope value and a zero net bias across the inputs and output.

Open the model rtwdemo_crlfixpt and use the buttons at the bottom of the model window to
explore the files that define and register the code replacement library mappings.

• By default, for addition and subtraction operator code replacements, the code generator assumes
that replacement code implements a cast-before-operation (CBO) algorithm.

• Using fixed-point data types in a model requires a Fixed-Point Designer™ license.

For more information about fixed-point operator code replacement, see “Fixed-Point Operator Code
Replacement” on page 67-169.

open_system('rtwdemo_crlfixpt')
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Match and Replacement Process Customization for Functions

This example defines and registers code replacement mappings for custom entries. You can create
your own entry by subclassing from RTW.TflCFunctionEntryML or RTW.TflCOperationEntryML.
Your entry class must implement a do_match method that customizes your matching logic or
modifies the matched entry. The do_match method must have a fixed preset signature.

 Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®

72-41



Open the model rtwdemo_crlcustomentry. The model shows how to modify the matched entry by
injecting constants as additional implementation function arguments. DTC1, Trigonometric
Function, and Product show custom entry code replacement for:

• Cast operation that demonstrates how to extract the fraction lengths from types and pass them
into the implementation function - Out1 = custom_cast(In1, 2, 4).

• Sine that demonstrates how to pass a constant value to the implementation function -
Out2=custom_sin(In2, 1).

• Multiplication operation that demonstrates how to compute the net slope of an operation and pass
that into the implementation function - Out3=custom_multiply_shift_right(In3,In4,3).

Use the buttons at the bottom of the model window to explore the files that define and register the
code replacement mappings.

For more information on custom entries, see “Customize Match and Replacement Process” on page
67-118.

open_system('rtwdemo_crlcustomentry')
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MATLAB Function Replacement

This example defines and registers code replacement mappings for MATLAB® functions specified in
the MATLAB Function block. The function can be opted for replacement by specifying
coder.replace within it. This feature supports replacement of MATLAB® functions with the
following:

• Single or multiple inputs
• Single or multiple outputs
• Scalar and matrix inputs and outputs

Open the model rtwdemo_crlcoderreplace. The model shows some of these requirements.
Supported types include:

• single, double
• int8, uint8
• int16, uint16
• int32, uint32
• csingle, cdouble
• cint8, cuint8
• cint16, cuint16
• cint32, cuint32
• Fixed-point integers
• Mixed types (different type on each input)

Use the buttons at the bottom of the model window to explore the files that define and register the
code replacement mappings.

For more information on MATLAB® function replacement, see coder.replace.

open_system('rtwdemo_crlcoderreplace')
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Data Alignment for Function Implementations

This example shows how to specify the alignment of matrix operands passed into a replacement
function. Some target-specific function implementations require data to be aligned to optimize
application performance. To configure data alignment for a function implementation:

• Specify the data alignment requirements in a table entry. You can specify alignment for
implementation function arguments individually or collectively.

• Specify the data alignment capabilities and syntax for your compiler. Attach an
AlignmentSpecification object to the TargetCharacteristics object of the registry entry
specified in your rtwTargetInfo.m file.

Open the model rtwdemo_crlalign. The model shows three data alignment code replacement
scenarios:

• Add - Alignment of exported and imported signals. You can specify an exact value for the
alignment in the Signal Properties dialog box or allow the code generator to determine the best
alignment based on usage by leaving the alignment value set to -1.

72 Execution Speed in Embedded Coder

72-44



• Product - Alignment of virtual and nonvirtual bus types. You can specify an exact value for the
alignment for the Alignment property of the Simulink.Bus object or allow the code generator to
determine the best alignment based on usage by leaving the Alignment property set to -1.

• EML_MMUL - Alignment of local variables, global variables, and block parameters.

Use the buttons at the bottom of the model window to explore the files that define and register the
code replacement mappings. Note that the model is configured to use a GCC, Clang, MSVC, or
MinGW compiler.

For more information on specifying data alignment for code replacement, see “Data Alignment for
Code Replacement” on page 67-97.

open_system('rtwdemo_crlalign')

Code Replacement Library Exploration and Verification

This example shows Code Replacement Viewer. You can use the Code Replacement Viewer to:
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• Explore which code replacement library to use
• Verify the list of tables in a library and the entries in each table
• Review table entry specifications
• Troubleshoot code replacement misses

The following commands open the Code Replacement Viewer for code replacement table
crl_tablemuldiv:

crl = crl_table_muldiv;
crviewer(crl);
daRoot = DAStudio.Root;
me = daRoot.find('-isa', 'DAStudio.Explorer');

For more information on the Code Replacement Viewer, see “Verify Code Replacement Library” on
page 67-55.

Build Information

For each entry in a code replacement table, you can specify build information such as the following,
for replacement functions:

• Header file dependencies
• Source file dependencies
• Additional include paths
• Additional source paths
• Additional link flags

Additionally, you can specify RTW.copyFileToBuildDir to copy header, source, or object files,
which are required to generate replacement code, to the build folder before code generation. You can
specify RTW.copyFileToBuildDir by setting it as the value of:

• Property GenCallback in a call to setTflCFunctionEntryParameters,
setTflCOperationEntryParameters, or setTflCSemaphoreEntryParameters.

• Argument genCallback in a call to registerCFunctionEntry, registerCOperationEntry,
or registerCSemaphoreEntry.

Note: Models in this example are configured for code generation only because the implementations
for the replacement functions are not provided.

For more information on specifying build information, see Specify build information in “Define Code
Replacement Library Optimizations” on page 67-36.

Reserved Identifiers

Each function implementation name defined by a code replacement table entry is reserved as a
unique identifier. You can specify other identifiers with a table on a per-header-file basis. Providing
additional reserved identifiers can help prevent duplicate symbols and other identifier related
compile and link issues.

For more information on specifying reserved identifiers, see “Reserved Identifiers and Code
Replacement” on page 67-117.
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Remove Example Code Replacement Libraries

When you finish using the example models, remove the example code replacement libraries and close
the example models with these commands:

rmpath(fullfile(matlabroot,'toolbox','rtw','rtwdemos','crl_demo'));
sl_refresh_customizations;

close_system('rtwdemo_crladdsub', 0)
close_system('rtwdemo_crl_cbo_cao', 0)
close_system('rtwdemo_crlmuldiv', 0)
close_system('rtwdemo_crlfixpt', 0)
close_system('rtwdemo_crlmath', 0)
close_system('rtwdemo_crlmatops', 0)
close_system('rtwdemo_crlblas', 0)
close_system('rtwdemo_crlscalarops', 0)
close_system('rtwdemo_crlcustomentry', 0)
close_system('rtwdemo_crlcoderreplace', 0)
close_system('rtwdemo_crlalign', 0)

drawnow;
if exist('h','var') && ishghandle(h)
  close(h);
end

if ~isempty(me)
    me(end).delete;
end

clear h;
clear me;
clear isDaDemoSupported;
clear crl;

rtwdemoclean;
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Improve Execution Efficiency by Reordering Block Operations
in the Generated Code

To improve execution efficiency, the code generator can change the block execution order. In the
Configuration Parameters dialog box, when you set the Optimize Block Order parameter to
Improved Execution Speed, the code generator can change the block operation order to
implement these optimizations:

• Eliminate data copies for blocks that perform inplace operations (that is, use the same input and
output variable) and contain algorithm code with unnecessary data copies.

• Combine more for loops by executing blocks together that have the same size.
• Reuse the same variable for the input, output, and state of a Unit Delay block by executing the

Unit Delay block before upstream blocks.

These optimizations improve execution speed and conserve RAM and ROM consumption.

Example Model

Open the model matlab:rtwdemo_optimizeblockorder. This model contains three subsystems for
demonstrating how reordering block operations improves execution efficiency.
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for Loop Fusion

The subsystem LoopFusionScheduling shows how the code generator reorders block operations so
that blocks that have the same output size execute together. This reordering enables for loop fusion.
Set the Optimize block order in the generated code parameter to Off.

In your system's temporary folder, create a folder for the build and inspection process and build the
model.

### Starting build procedure for: rtwdemo_optimizeblockorder
### Successful completion of build procedure for: rtwdemo_optimizeblockorder

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
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rtwdemo_optimizeblockorder  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.385s

View the generated code without the optimization. Code for the LoopFusionScheduling
subsystem:

/* Output and update for atomic system: '<Root>/LoopFusionScheduling' */
static void LoopFusionScheduling(const real_T rtu_In1[6], const real_T rtu_In2[6],
  const real_T rtu_In3[6], const real_T rtu_In4[6], real_T rty_Out1[6], real_T
  rty_Out2[9], real_T rty_Out3[6], real_T rty_Out4[9])
{
  int32_T i;
  int32_T i_0;
  int32_T tmp;
  int32_T tmp_0;

  /* Bias: '<S2>/Bias' incorporates:
   *  Gain: '<S2>/Gain'
   */
  for (i = 0; i < 6; i++) {
    rty_Out1[i] = -0.3 * rtu_In1[i] + 0.5;
  }

  /* End of Bias: '<S2>/Bias' */

  /* Product: '<S2>/Product' */
  for (i = 0; i < 3; i++) {
    for (i_0 = 0; i_0 < 3; i_0++) {
      tmp = i_0 + 3 * i;
      rty_Out2[tmp] = 0.0;
      tmp_0 = i << 1;
      rty_Out2[tmp] += rtu_In2[tmp_0] * rtu_In1[i_0];
      rty_Out2[tmp] += rtu_In2[tmp_0 + 1] * rtu_In1[i_0 + 3];
    }
  }

  /* End of Product: '<S2>/Product' */

  /* Bias: '<S2>/Bias1' incorporates:
   *  Gain: '<S2>/Gain1'
   */
  for (i = 0; i < 6; i++) {
    rty_Out3[i] = -0.3 * rtu_In3[i] + 0.5;
  }

  /* End of Bias: '<S2>/Bias1' */

  /* Product: '<S2>/Product1' */
  for (i = 0; i < 3; i++) {
    for (i_0 = 0; i_0 < 3; i_0++) {
      tmp = i_0 + 3 * i;
      rty_Out4[tmp] = 0.0;
      tmp_0 = i << 1;
      rty_Out4[tmp] += rtu_In4[tmp_0] * rtu_In3[i_0];
      rty_Out4[tmp] += rtu_In4[tmp_0 + 1] * rtu_In3[i_0 + 3];
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    }
  }

  /* End of Product: '<S2>/Product1' */
}

With the default execution order, the blocks execute from left to right and from top to bottom. As a
result, there are separate for loops for the two combinations of Gain and Bias blocks and the Product
blocks.

Generate code with the optimization. Set the Optimize block order in the generated code
parameter to Improved Execution Speed and build the model.

### Starting build procedure for: rtwdemo_optimizeblockorder
### Successful completion of build procedure for: rtwdemo_optimizeblockorder

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_optimizeblockorder  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.686s

View the generated code with the optimization.

/* Output and update for atomic system: '<Root>/LoopFusionScheduling' */
static void LoopFusionScheduling(const real_T rtu_In1[6], const real_T rtu_In2[6],
  const real_T rtu_In3[6], const real_T rtu_In4[6], real_T rty_Out1[6], real_T
  rty_Out2[9], real_T rty_Out3[6], real_T rty_Out4[9])
{
  int32_T i;
  int32_T i_0;
  int32_T tmp;
  int32_T tmp_0;
  for (i = 0; i < 3; i++) {
    for (i_0 = 0; i_0 < 3; i_0++) {
      /* Product: '<S2>/Product' incorporates:
       *  Product: '<S2>/Product1'
       */
      tmp = i_0 + 3 * i;
      rty_Out2[tmp] = 0.0;

      /* Product: '<S2>/Product1' */
      rty_Out4[tmp] = 0.0;

      /* Product: '<S2>/Product' incorporates:
       *  Product: '<S2>/Product1'
       */
      tmp_0 = i << 1;
      rty_Out2[tmp] += rtu_In2[tmp_0] * rtu_In1[i_0];

      /* Product: '<S2>/Product1' */
      rty_Out4[tmp] += rtu_In4[tmp_0] * rtu_In3[i_0];
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      /* Product: '<S2>/Product' */
      rty_Out2[tmp] += rtu_In2[tmp_0 + 1] * rtu_In1[i_0 + 3];

      /* Product: '<S2>/Product1' incorporates:
       *  Product: '<S2>/Product'
       */
      rty_Out4[tmp] += rtu_In4[tmp_0 + 1] * rtu_In3[i_0 + 3];
    }
  }

  for (i = 0; i < 6; i++) {
    /* Bias: '<S2>/Bias' incorporates:
     *  Gain: '<S2>/Gain'
     */
    rty_Out1[i] = -0.3 * rtu_In1[i] + 0.5;

    /* Bias: '<S2>/Bias1' incorporates:
     *  Gain: '<S2>/Gain1'
     */
    rty_Out3[i] = -0.3 * rtu_In3[i] + 0.5;
  }
}

In the optimized code, blocks with the same output size execute together. The two sets of Gain and
Bias blocks have an output dimension size of 6, so they execute together. The Product blocks have an
output dimension size of 9, so they execute together. The fusion of for loops enables the code
generator to set the value of the expression 3 * i + i_0 equal to the temporary variable tmp_0.
This optimization also improves execution efficiency.

Buffer Reuse for the Input, Output, and State of Unit Delay Blocks

The subsystem RegionScheduling shows how the code generator reorders block operations to
enable buffer reuse for the input, output, and state of Unit Delay blocks. When computation is part of
separate regions that connect only through Delay blocks, the code generator can change the block
execution order so that the downstream regions execute before the upstream regions. This execution
order enables maximum reuse of Delay block states and input and output variables. Set the Optimize
block order in the generated code parameter to Off and build the model.

### Starting build procedure for: rtwdemo_optimizeblockorder
### Successful completion of build procedure for: rtwdemo_optimizeblockorder

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_optimizeblockorder  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.075s

View the generated code without the optimization. Code for the RegionScheduling subsystem:

/* Output and update for atomic system: '<Root>/RegionScheduling' */
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static void RegionScheduling(const real_T rtu_In1[6], const real_T rtu_In2[6],
  real_T rty_Out1[6], rtDW_RegionScheduling *localDW)
{
  real_T rtb_Sum;
  int32_T i;
  for (i = 0; i < 6; i++) {
    /* Sum: '<S3>/Sum' incorporates:
     *  UnitDelay: '<S3>/Delay'
     *  UnitDelay: '<S3>/UnitDelay'
     */
    rtb_Sum = localDW->Delay_DSTATE[i] + localDW->UnitDelay_DSTATE[i];

    /* UnitDelay: '<S3>/UnitDelay2' */
    rty_Out1[i] = localDW->UnitDelay2_DSTATE[i];

    /* Update for UnitDelay: '<S3>/Delay' incorporates:
     *  Bias: '<S3>/Bias'
     */
    localDW->Delay_DSTATE[i] = rtu_In1[i] + 3.0;

    /* Update for UnitDelay: '<S3>/UnitDelay' incorporates:
     *  Gain: '<S3>/Gain'
     */
    localDW->UnitDelay_DSTATE[i] = 2.0 * rtu_In2[i];

    /* Update for UnitDelay: '<S3>/UnitDelay2' */
    localDW->UnitDelay2_DSTATE[i] = rtb_Sum;
  }
}

With the default execution order, the generated code contains the extra, temporary variable rtb_Sum
and a data copy.

Generate code with the optimization. Set the Optimize block order in the generated code
parameter to Improved Execution Speed and build the model.

### Starting build procedure for: rtwdemo_optimizeblockorder
### Successful completion of build procedure for: rtwdemo_optimizeblockorder

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_optimizeblockorder  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.652s

View the generated code with the optimization.

/* Output and update for atomic system: '<Root>/RegionScheduling' */
static void RegionScheduling(const real_T rtu_In1[6], const real_T rtu_In2[6],
  real_T rty_Out1[6], rtDW_RegionScheduling *localDW)
{
  int32_T i;
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  for (i = 0; i < 6; i++) {
    /* UnitDelay: '<S3>/UnitDelay2' */
    rty_Out1[i] = localDW->UnitDelay2_DSTATE[i];

    /* Sum: '<S3>/Sum' incorporates:
     *  UnitDelay: '<S3>/Delay'
     *  UnitDelay: '<S3>/UnitDelay'
     *  UnitDelay: '<S3>/UnitDelay2'
     */
    localDW->UnitDelay2_DSTATE[i] = localDW->Delay_DSTATE[i] +
      localDW->UnitDelay_DSTATE[i];

    /* Bias: '<S3>/Bias' incorporates:
     *  UnitDelay: '<S3>/Delay'
     */
    localDW->Delay_DSTATE[i] = rtu_In1[i] + 3.0;

    /* Gain: '<S3>/Gain' incorporates:
     *  UnitDelay: '<S3>/UnitDelay'
     */
    localDW->UnitDelay_DSTATE[i] = 2.0 * rtu_In2[i];
  }
}

In the optimized code, the blocks in Regions 3, 2, and 1 execute in that order. With that execution
order, the generated code does not contain the temporary variable rtb_Sum and the corresponding
data copy.

Eliminate Data Copies for Blocks That Perform Inplace Operations

The subsystem InplaceScheduling shows how the code generator reorders block operations to
eliminate data copies for blocks that perform inplace operations. In the Configuration Parameters
dialog box, set the Optimize block order in the generated code parameter to Off and build the
model.

### Starting build procedure for: rtwdemo_optimizeblockorder
### Successful completion of build procedure for: rtwdemo_optimizeblockorder

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_optimizeblockorder  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.969s

View the generated code without the optimization. Code for the InplaceScheduling subsystem:

/* Output and update for atomic system: '<Root>/InplaceScheduling' */
static void InplaceScheduling(void)
{
  real_T rtb_Max[6];
  real_T acc;
  int32_T idx1;
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  int32_T idx2;
  int32_T k;
  for (idx1 = 0; idx1 < 6; idx1++) {
    /* Sum: '<S1>/Sum2x3' incorporates:
     *  Inport: '<Root>/In7'
     *  UnitDelay: '<S1>/Unit Delay'
     */
    rtDWork.UnitDelay_DSTATE[idx1] += rtU.In7[idx1];

    /* MinMax: '<S1>/Max' */
    acc = rtDWork.UnitDelay_DSTATE[idx1];
    if (2.0 > acc) {
      rtb_Max[idx1] = 2.0;
    } else {
      rtb_Max[idx1] = acc;
    }

    /* End of MinMax: '<S1>/Max' */
  }

  /* S-Function (sdsp2norm2): '<S1>/Normalization' incorporates:
   *  Outport: '<Root>/Out7'
   */
  idx1 = 0;
  idx2 = 0;
  acc = 0.0;
  for (k = 0; k < 6; k++) {
    acc += rtb_Max[idx1] * rtb_Max[idx1];
    idx1++;
  }

  acc = 1.0 / (sqrt(acc) + 1.0E-10);
  for (k = 0; k < 6; k++) {
    rtY.Out7[idx2] = rtb_Max[idx2] * acc;
    idx2++;

    /* Outport: '<Root>/Out6' incorporates:
     *  Bias: '<S1>/Bias'
     *  Inport: '<Root>/In8'
     *  Outport: '<Root>/Out7'
     *  Product: '<S1>/Product'
     */
    rtY.Out6[k] = (rtU.In8 + 1.0) * rtDWork.UnitDelay_DSTATE[k];

    /* Switch: '<S1>/Switch' incorporates:
     *  Inport: '<Root>/In9'
     */
    if (rtU.In9[k] > 0.0) {
      /* Update for UnitDelay: '<S1>/Unit Delay' */
      rtDWork.UnitDelay_DSTATE[k] = 0.0;
    } else {
      /* Update for UnitDelay: '<S1>/Unit Delay' */
      rtDWork.UnitDelay_DSTATE[k] = rtb_Max[k];
    }

    /* End of Switch: '<S1>/Switch' */
  }
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  /* End of S-Function (sdsp2norm2): '<S1>/Normalization' */
}

With the default execution order, the Max block executes before the Product block. To hold the Sum
block output, the generated code contains two variables, UnitDelay_DSTATE and rtb_Max.

Generate code with the optimization. Set the Optimize block order in the generated code
parameter to Improved Execution Speed and build the model.

### Starting build procedure for: rtwdemo_optimizeblockorder
### Successful completion of build procedure for: rtwdemo_optimizeblockorder

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_optimizeblockorder  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.595s

View the generated code with the optimization.

/* Output and update for atomic system: '<Root>/InplaceScheduling' */
static void InplaceScheduling(void)
{
  real_T acc;
  int32_T idx1;
  int32_T idx2;
  int32_T k;
  for (idx1 = 0; idx1 < 6; idx1++) {
    /* Sum: '<S1>/Sum2x3' incorporates:
     *  Inport: '<Root>/In7'
     *  UnitDelay: '<S1>/Unit Delay'
     */
    rtDWork.UnitDelay_DSTATE[idx1] += rtU.In7[idx1];

    /* Outport: '<Root>/Out6' incorporates:
     *  Bias: '<S1>/Bias'
     *  Inport: '<Root>/In8'
     *  Product: '<S1>/Product'
     */
    rtY.Out6[idx1] = (rtU.In8 + 1.0) * rtDWork.UnitDelay_DSTATE[idx1];

    /* MinMax: '<S1>/Max' */
    acc = rtDWork.UnitDelay_DSTATE[idx1];
    if (2.0 > acc) {
      rtDWork.UnitDelay_DSTATE[idx1] = 2.0;
    } else {
      rtDWork.UnitDelay_DSTATE[idx1] = acc;
    }

    /* End of MinMax: '<S1>/Max' */
  }
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  /* S-Function (sdsp2norm2): '<S1>/Normalization' incorporates:
   *  Outport: '<Root>/Out7'
   */
  idx1 = 0;
  idx2 = 0;
  acc = 0.0;
  for (k = 0; k < 6; k++) {
    acc += rtDWork.UnitDelay_DSTATE[idx1] * rtDWork.UnitDelay_DSTATE[idx1];
    idx1++;
  }

  acc = 1.0 / (sqrt(acc) + 1.0E-10);
  for (k = 0; k < 6; k++) {
    rtY.Out7[idx2] = rtDWork.UnitDelay_DSTATE[idx2] * acc;
    idx2++;
  }

  /* End of S-Function (sdsp2norm2): '<S1>/Normalization' */

  /* Update for UnitDelay: '<S1>/Unit Delay' */
  for (idx1 = 0; idx1 < 6; idx1++) {
    /* Switch: '<S1>/Switch' incorporates:
     *  Inport: '<Root>/In9'
     */
    if (rtU.In9[idx1] > 0.0) {
      rtDWork.UnitDelay_DSTATE[idx1] = 0.0;
    }

    /* End of Switch: '<S1>/Switch' */
  }

  /* End of Update for UnitDelay: '<S1>/Unit Delay' */
}

The optimized code does not contain the variable rtb_Max or the data copy. The generated code
contains one variable, UnitDelay_DSTATE, for holding the Sum block output. The Product block
reads from UnitDelay_DSTATE and the Max block reads from and writes to UnitDelay_DSTATE.

To implement buffer reuse, the code generator does not violate user-specified block priorities.

See Also
“Optimize block operation order in the generated code”

Related Examples
• “Remove Data Copies by Reordering Block Operations in the Generated Code” on page 71-25
• “Optimization Tools and Techniques” on page 69-7
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Generate SIMD Code from Simulink Blocks
You can generate SIMD (single instruction, multiple data) code from certain Simulink blocks by using
Intel AVX and Intel SSE technology. SIMD is a computing paradigm in which a single instruction
processes multiple data. Many modern processors have SIMD instructions that, for example, perform
several additions or multiplications at once. For computationally intensive operations on supported
blocks, SIMD intrinsics can significantly improve the performance of the generated code on Intel
platforms.

Blocks That Support SIMD Code Generation
When certain conditions are met, you can generate SIMD code by using Intel SE or Intel AVX
technology. This table lists blocks that support SIMD code generation. The table also details the
conditions under which the support is available.

Block Conditions
Add • For Intel AVX and Intel SSE, the input signal

has a data type of single, double, int32, or
int64.

• For Intel AVX-512, the input signal has a data
type of single or double.

Subtract • For Intel AVX and Intel SSE, the input signal
has a data type of single, double, int32, or
int64.

• For Intel AVX-512, the input signal has a data
type of single or double.

Product • For Intel AVX and Intel SSE, the input signal
has a data type of single, double, or int32.

• For Intel AVX-512, the input signal has a data
type of single or double.

• Set Multiplication parameter to Element-
wise(.*)

Gain • For Intel AVX or Intel SSE, the input signal
has a data type of single, double, or int32.

• For Intel AVX-512, the input signal has a data
type of single or double.

• Set Multiplication parameter to Element-
wise(.*)

Divide The input signal has a data type of single or
double.

Sqrt The input signal has a data type of single or
double.

Ceil • For Intel SSE and Intel AVX, the input signal
has a data type of single or double.

• Intel AVX-512 is not supported.
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Block Conditions
Floor • For Intel SSE and Intel AVX, the input signal

has a data type of single or double.
• Intel AVX-512 is not supported.

MinMax • The input signal has a data type of single or
double.

• The value of the Support: non-finite
numbers configuration parameter is set to
off.

MATLAB Function MATLAB code meets the conditions specified in
this topic: “Generate SIMD Code for MATLAB
Functions” on page 89-27.

For Each Subsystem • The For Each Subsystem block contains a
block listed in this table that meets the
specified conditions.

• The value of the Partition Dimension block
parameter must be above the value of the
Loop unrolling threshold configuration
parameter.

If you have DSP System Toolbox, you can also generate SIMD code from certain DSP System Toolbox
blocks. For more information, see “Simulink Blocks in DSP System Toolbox that Support SIMD Code
Generation” (DSP System Toolbox).

Generate SIMD Code Compared to Plain C Code
The simple model simdDemo has a Subtract block and a Divide block. The Subtract block has an input
signal that has a dimension of 240 and an input data type of single. The Divide block has an input
signal that has a dimension of 140 and an input data type of double.

The plain generated C code for this model is:

void simdDemo_step(void)
{
  int32_T i;

 Generate SIMD Code from Simulink Blocks

72-59



  for (i = 0; i < 240; i++) {
    simdDemo_Y.Out1[i] = simdDemo_U.In1[i] - simdDemo_U.In2[i];
  }

  for (i = 0; i < 140; i++) {
    simdDemo_Y.Out2[i] = simdDemo_U.In3[i] / simdDemo_U.In4[i];
  }
}

In the plain (non-SIMD) C code, each loop iteration produces one result.

To generate SIMD code

1 Open the Embedded Coder app.
2 Click Settings > Hardware Implementation.
3 Set the Device vendor parameter to Intel or AMD.
4 Set the Device type parameter to x86-64(Windows 64) or x86-64(Linux 64).
5 On the Interface pane, for the Code replacement libraries parameter, click Select. In the

dialog box that opens, choose an Intel AVX or Intel SSE library. The library that you choose
depends on which instruction set extension your processor supports. For more information, see
https://www.intel.com/content/www/us/en/support/articles/000005779/processors.html. This table
lists which Intel intrinsic instructions sets each code replacement library contains:

Code Replacement Library Intel Intrinsic Instruction Set
Intel SSE SSE, SSE2, SSE4.1
Intel AVX SSE, SSE2, SSE4.1, AVX, AVX2
Intel AVX-512 SSE, SSE2, SSE4.1, AVX, AVX2, AVX-512

6 Generate code from the model.

void simdDemo_step(void)
{
  int32_T i;
  for (i = 0; i <= 236; i += 4) {
    _mm_storeu_ps(&simdDemo_Y.Out1[i], _mm_sub_ps(_mm_loadu_ps(&simdDemo_U.In1[i]),
      _mm_loadu_ps(&simdDemo_U.In2[i])));
  }

  for (i = 0; i <= 138; i += 2) {
    _mm_storeu_pd(&simdDemo_Y.Out2[i], _mm_div_pd(_mm_loadu_pd(&simdDemo_U.In3[i]),
      _mm_loadu_pd(&simdDemo_U.In4[i])));
  }
}
   
 

This code is for the Intel SSE code replacement library. The SIMD instructions are the intrinsic
functions that start with the identifier _mm. These functions process multiple data in a single iteration
of the loop because the loop increments by four for single data types and by two for double data
types. For models that process more data and are computationally more intensive than this one, the
presence of SIMD instructions can significantly speed up the code execution time.

For a list of a Intel intrinsic functions for supported Simulink blocks, see https://software.intel.com/
sites/landingpage/IntrinsicsGuide/.
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Limitations
The generated code is not optimized through SIMD if:

• The code in a MATLAB Function block contains scalar data types outside the body of loops. For
instance, if a,b, and c are scalars, the generated code does not optimize an operation such as c=a
+b.

• The code in a MATLAB Function block contains indirectly indexed arrays or matrices. For instance
if A,B,C, and D are vectors, the generated code is not vectorized for an operation such as
D(A)=C(A)+B(A).

• The blocks within a reusable subsystem might not be optimized.
• If the code in a MATLAB Function block contains parallel for-Loops (parfor), the parfor loop is

not optimized with SIMD code, but loops within the body of the parfor loop can be optimized
with SIMD code.

See Also

More About
• “What Is Code Replacement?” on page 55-2
• “Optimize Generated Code by Using Multiple Code Replacement Libraries” on page 67-210
• “Generate SIMD Code for MATLAB Functions” on page 89-27
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Speed Up for-Loop Implementation in Code Generated by
Using parfor

When you generate C/C++ code for a model by using a MATLAB Function, a MATLAB System, and
For Each subsystem block, by default, the code generator produces code that implements for-loops
in a single thread. This for-loop can be optimized for MATLAB Function and MATLAB System blocks.
The iterations of the parfor-loop can run in parallel on multiple cores on the target hardware.

Running the iterations in parallel might significantly improve execution speed of generated code. For
more information, see “How parfor-Loops Improve Execution Speed” on page 72-62.

The code generator implements the for-loops in parallel by using OpenMP.

Embedded Coder software uses the Open Multiprocessing (OpenMP) application interface to support
shared-memory, multicore code generation. By default, Embedded Coder uses as many threads as it
finds available. If you specify the number of threads to use, Embedded Coder uses at most that
number of threads, even if additional threads are available. For more information, see parfor.

How parfor-Loops Improve Execution Speed
A parfor-loop might provide better execution speed than its analogous for-loop because several
threads can compute concurrently on the same loop.

Each execution of the body of a parfor-loop is called an iteration. The threads evaluate iterations in
an arbitrary order and independently of each other. Because each iteration is independent, the
threads do not have to be synchronized. If the number of threads is equal to the number of loop
iterations, each thread performs one iteration of the loop. If the number of iterations is greater than
the number of threads, some threads perform more than one loop iteration.

For example, when a loop of 100 iterations runs on 20 threads, each thread simultaneously executes
five iterations of the loop. If your loop takes a long time to run because of the large number of
iterations or lengthy individual iterations, you can reduce the run time significantly by using multiple
threads. In this example, you might not get 20 times improvement in speed because of parallelization
overheads, such as thread creation and deletion.

When to Use parfor-Loops
Use parfor when you have:

• Many iterations of a simple calculation. parfor divides the loop iterations into groups so that
each thread executes one group of iterations.

• A loop iteration that takes a long time to execute. parfor executes the iterations simultaneously
on different threads. Although this simultaneous execution does not reduce the time spent on an
individual iteration, it might significantly reduce overall time spent on the loop.

When Not to Use parfor-Loops
Do not use parfor when:

• An iteration of your loop depends on other iterations. Running the iterations in parallel can lead to
erroneous results.
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To help you avoid using parfor when an iteration of your loop depends on other iterations,
Embedded Coder specifies a rigid classification of variables. For more information, see
“Classification of Variables in parfor-Loops”. If Embedded Coder detects loops that do not conform
to the parfor specifications, it does not generate code and produces an error.

Reductions are an exception to the rule that loop iterations must be independent. A reduction
variable accumulates a value that depends on all the iterations together, but is independent of the
iteration order. For more information, see “Reduction Variables”.

• There are only a few iterations that perform some simple calculations.

Note For small number of loop iterations, you might not accelerate execution due to
parallelization overheads. Such overheads include time taken for thread creation, data
synchronization between threads, and thread deletion.

• For Each Subsystem contains an S-Function block. The generated code will not contain parfor.

Write Code by Using parfor-Loops
To run for-loops in parallel in the generated code, write the code within a MATLAB Function, or a
MATLAB System, block using parfor.

1 Create a Simulink model.
2 Add the MATLAB Function or the MATLAB System block to the model.
3 Add the code to the MATLAB Function or the MATLAB System block.

function y = access3a(u) %#codegen

%   Copyright 2010 The MathWorks, Inc.

persistent pA;
if isempty(pA)
    pA = 0;
end
A = ones(20,50);
t = 0;

parfor (i = 1:10,4) 
    A(i,1) = A(i,1) + 1;                    
end

y = A(1,4) + u + t + pA;
4 In the Optimization pane select the Maximize execution speed option from the “Priority”

drop-down list. The parameter “Generate parallel for-loops” is automatically selected. The
parameter enables the compiler to compute loops in parallel.

5 Connect the blocks.

6 Build the model and generate code.

In the generated code, the pragma instructs the compiler to execute the looping in OpenMP
parallel for-loops through multithreading :
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#pragma omp parallel for num_threads(4 > 
                omp_get_max_threads() ? omp_get_max_threads() : 4)

The number 4 indicates the number of processing threads.

Because the loop body can execute in parallel on multiple threads, it must conform to certain
restrictions. If the Embedded Coder software detects loops that do not conform to parfor
specifications, it produces an error. For more information, see “parfor Restrictions”.

See Also

More About
• “Classification of Variables in parfor-Loops”
• “Algorithm Acceleration Using Parallel for-Loops (parfor)”
• “Reduction Assignments in parfor-Loops”
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Memory Usage in Embedded Coder

• “Optimize Generated Code Using Minimum and Maximum Values” on page 73-2
• “Reduce Global Variables in Nonreusable Subsystem Functions” on page 73-8
• “Optimize Generated Code By Packing Boolean Data Into Bitfields” on page 73-11
• “Optimize Generated Code By Passing Reusable Subsystem Outputs as Individual Arguments”

on page 73-14
• “Convert Data Copies to Pointer Assignments” on page 73-18
• “Reuse Buffers of Different Sizes and Dimensions” on page 73-22
• “Remove Reset and Disable Functions from the Generated Code” on page 73-28
• “Optimize Speed and Size of Signal Processing Algorithm by Using Fixed-Point Data”

on page 73-31
• “Control Operator Type in Generated Code” on page 73-32
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Optimize Generated Code Using Minimum and Maximum
Values

To optimize the generated code for your model, you can choose an option to use input range
information, also known as design minimum and maximum, that you specify on signals and
parameters. These minimum and maximum values usually represent environmental limits, such as
temperature, or mechanical and electrical limits, such as output ranges of sensors.

In the Configuration Parameters dialog box, on the Optimization pane, when you select the
Optimize using specified minimum and maximum values check box, the software uses the
minimum and maximum values to derive range information for downstream signals in the model. It
then uses this derived range information to determine if it is possible to streamline the generated
code by:

• Reducing expressions to constants
• Removing dead branches of conditional statements
• Eliminating unnecessary mathematical operations

This optimization results in:

• Reduced ROM and RAM consumption
• Improved execution speed

Configure Your Model
To make optimization more likely:

• Provide as much design minimum and maximum information as possible. Specify minimum and
maximum values for signals and parameters in the model for:

• Inport and Outport blocks
• Block outputs
• Block inputs, for example, for the MATLAB Function and Stateflow Chart blocks
• Simulink.Signal objects

• Before generating code, test the minimum and maximum values for signals and parameters.
Otherwise, optimization might result in numerical mismatch with simulation. You can simulate
your model with simulation range checking enabled. If errors or warnings occur, fix these issues
before generating code.

Enable Simulation Range Checking

1 In the Configuration Parameters dialog box, select Diagnostics > Data Validity.
2 On the Data Validity pane, under Signals, set Simulation range checking to warning or

error.
• Provide design minimum and maximum information upstream of blocks as close to the inputs of

the blocks as possible. If you specify minimum and maximum values for a block output, these
values are most likely to affect the outputs of the blocks immediately downstream.
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Optimize Generated Code Using Specified Minimum and Maximum
Values
This example shows how the minimum and maximum values specified on signals and parameters in a
model are used to optimize the generated code.

Overview

The specified minimum and maximum values usually represent environmental limits, such as
temperature, or mechanical and electrical limits, such as output ranges of sensors.

This optimization uses these values to streamline the generated code. For example, it reduces
expressions to constants or removes dead branches of conditional statements.

NOTE: Make sure the minimum and maximum values that you specify are valid limits. Otherwise,
this optimization might result in numerical mismatch with simulation.

The benefits of optimizing the generated code are:

• Reducing the ROM and RAM consumption.
• Improving the execution speed.

Review Minimum and Maximum Information

Consider the model rtwdemo_minmax. In this model, there are minimum and maximum values
specified on Inports and on the gain parameter of the Gain block.

model = 'rtwdemo_minmax';
open_system(model);
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Generate Code Without This Optimization

First, generate code for this model without considering the min and max values.

currentDir = pwd;
[~,cgDir] = rtwdemodir();
rtwconfiguredemo(model,'ERT')
slbuild(model)

### Starting build procedure for: rtwdemo_minmax
### Successful completion of build procedure for: rtwdemo_minmax

Build Summary

Top model targets built:

Model           Action                       Rebuild Reason                                    
===============================================================================================
rtwdemo_minmax  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 12.333s

A portion of rtwdemo_minmax.c is listed below.

cfile = fullfile(cgDir,'rtwdemo_minmax_ert_rtw','rtwdemo_minmax.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
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void rtwdemo_minmax_step(void)
{
  int32_T tmp;

  /* Sum: '<Root>/Sum' incorporates:
   *  Inport: '<Root>/U1'
   *  Inport: '<Root>/U2'
   *  Sum: '<Root>/Sum2'
   *  Switch: '<Root>/Switch'
   */
  tmp = U1 + U2;

  /* Switch: '<Root>/Switch' incorporates:
   *  Gain: '<Root>/Gain'
   *  Inport: '<Root>/U3'
   *  RelationalOperator: '<Root>/Relational Operator'
   *  Sum: '<Root>/Sum'
   */
  if (tmp <= k * U3) {
    /* Outport: '<Root>/Out1' incorporates:
     *  Sum: '<Root>/Sum2'
     */
    rtY.Out1 = tmp + U3;
  } else {
    /* Outport: '<Root>/Out1' incorporates:
     *  Inport: '<Root>/U1'
     *  Inport: '<Root>/U2'
     *  Product: '<Root>/Product'
     */
    rtY.Out1 = U1 * U2 * U3;
  }
}

Enable This Optimization
1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, select Optimize using the specified minimum and maximum

values.

Alternatively, you can enable this optimization by setting the command-line parameter.

set_param(model, 'UseSpecifiedMinMax', 'on');

Generate Code With This Optimization

In the model, with the specified minimum and maximum values for U1 and U2, the sum of U1 and U2
has a minimum value of 50. Considering the range of U3 and the specified minimum and maximum
values for the Gain block parameter, the maximum value of the Gain block's output is 40.

The output of the Relational Operator block remains false, and the output of the Switch block remains
the product of the three inputs.

Configure and build the model using Embedded Coder.

rtwconfiguredemo(model,'ERT')
slbuild(model)

### Starting build procedure for: rtwdemo_minmax
### Successful completion of build procedure for: rtwdemo_minmax
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Build Summary

Top model targets built:

Model           Action                       Rebuild Reason                   
==============================================================================
rtwdemo_minmax  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.597s

View the optimized code from rtwdemo_minmax.c.

cfile = fullfile(cgDir,'rtwdemo_minmax_ert_rtw','rtwdemo_minmax.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_minmax_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/U1'
   *  Inport: '<Root>/U2'
   *  Inport: '<Root>/U3'
   *  Product: '<Root>/Product'
   *  Switch: '<Root>/Switch'
   */
  rtY.Out1 = U1 * U2 * U3;
}

Close the model and cleanup.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Limitations
• This optimization does not take into account minimum and maximum values for:

• Merge block inputs. To work around this issue, use a Simulink.Signal object on the Merge
block output and specify the range on this object.

• Bus elements.
• Conditionally-executed subsystem (such as a triggered subsystem) block outputs that are

directly connected to an Outport block.

Outport blocks in conditionally-executed subsystems can have an initial value specified for use
only when the system is not triggered. In this case, the optimization cannot use the range of
the block output because the range might not cover the initial value of the block.

• If you use Polyspace software to verify code generated using this optimization, it might mark code
that was previously green as orange. For example, if your model contains a division where the
range of the denominator does not include zero, the generated code does not include protection
against division by zero. Polyspace might mark this code orange because it does not have
information about the minimum and maximum values for the inputs to the division.
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Polyspace Code Prover automatically captures some minimum and maximum values specified in
the MATLAB workspace, for example, for Simulink.Signal and Simulink.Parameter objects.
In this example, to provide range information to the Polyspace software, use a Simulink.Signal
object on the input of the division and specify a range that does not include zero.

Polyspace Code Prover stores these values in a Data Range Specification (DRS) file. However, they
do not capture all minimum and maximum values in your Simulink model. To provide additional
minimum and maximum information to Polyspace, you can manually define a DRS file.

• If you are using double-precision data types and the non-finite numbers configuration parameter
is selected, this optimization does not occur.

• If your model contains multiple instances of a reusable subsystem and each instance uses input
signals with different minimum and maximum values, this optimization might result in different
generated code for each subsystem so code reuse does not occur. Without this optimization, code
is generated once for the subsystem and shares this code among the multiple instances of the
subsystem.

• The Model Advisor check Check safety-related optimization settings generates a warning if this
option is selected. For many safety-critical applications, removing dead code automatically is
unacceptable because doing so might make code untraceable.

See Also
“Optimize using the specified minimum and maximum values”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Specify Signal Ranges”
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Reduce Global Variables in Nonreusable Subsystem Functions
Global variables can increase memory requirements and reduce execution speed. To reduce global
RAM for a nonreusable subsystem, you can generate a function interface that passes data through
arguments instead of global variables. The Subsystem block parameter Function interface provides
this option. To compare the outputs for the Function interface options, first generate a function for
a subsystem with a void-void interface, and then generate a function with arguments.

Generate void-void Function
By default, when you configure a Subsystem block as a nonreusable function, it generates a void-
void interface.

1 Open the example model rtwdemo_roll.
2 Right-click the subsystem RollAngleReference. From the list select Block Parameter

(Subsystem).
3 In the Block Parameters dialog box, confirm that the Treat as atomic unit check box is selected.
4 Click the Code Generation tab and set the Code interface packaging parameter to

Nonreusable function.
5 The Function interface parameter is already set to void_void.
6 Click Apply and OK.
7 Repeat steps 2–6, for the other subsystems HeadingMode and BasicRollMode.
8 Generate code and the static code metrics report for rtwdemo_roll. This model is configured to

generate a code generation report and to open the report automatically. For more information,
see “Generate Static Code Metrics Report for Simulink Model” on page 52-27.

In the code generation report, in rtwdemo_roll.c, the generated code for subsystem
RollAngleReference contains a void-void function definition:

 static void RollAngleReference(void)
 {
  ... 
 }

In the static code metrics report, navigate to Global Variables. With the void_void option, the
number of bytes for global variables is 47.
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Next, generate the same function with the Allow arguments (Optimized) option to compare the
results.

Generate Function with Arguments
To reduce global RAM, improve ROM usage and execution speed, generate a function that allows
arguments:

1 Open the Subsystem Block Parameter dialog box for RollAngleReference.
2 Click the Code Generation tab. Set the Function interface parameter to Allow arguments

(Optimized).
3 Click Apply and OK.
4 Repeat steps 2 and 3, for the other subsystems HeadingMode and BasicRollMode.
5 Generate code and the static code metrics report for rtwdemo_roll.

In the code generation report, in rtwdemo_roll.c, the generated code for subsystem
RollAngleReference now has arguments:

static real32_T RollAngleReference(real32_T rtu_Phi,... 
                                   boolean_T rtu_AP_Eng,...
                                   real32_T rtu_Turn_Knob)
 {
 ... 
 }

In the static code metrics report, navigate to Global Variables. With the Allow arguments option
set, the total number of bytes for global variables is now 39 bytes.

In some cases, when generating optimized code, the code generator might not generate a function
that has arguments. To generate a predictable function interface that has arguments, set Function
interface to Allow arguments (Match graphical interface).

See Also
“Function interface”
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Related Examples
• “Generate Predictable Function Interface to Match Graphical Block Interface” on page 4-4
• “Optimization Tools and Techniques” on page 69-7
• “Generate Subsystem Code as Separate Function and Files” on page 3-10
• “Optimize Generated Code By Passing Reusable Subsystem Outputs as Individual Arguments”

on page 73-14
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Optimize Generated Code By Packing Boolean Data Into
Bitfields

This example shows how to optimize the generated code by packing Boolean data into bitfields. When
you select the model configuration parameter Pack Boolean data into bitfields, Embedded Coder®
packs the Boolean signals into 1-bit bitfields, reducing RAM consumption. By default, the optimization
is enabled. This optimization reduces the RAM consumption. Be aware that this optimization can
potentially increase code size and execution speed.

Example Model

Consider the model rtwdemo_pack_boolean.

model = 'rtwdemo_pack_boolean';
open_system(model);

Disable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, clear Pack Boolean data into bitfields.

Alternatively, you can use the command-line API to disable the optimization:

set_param(model,'BooleansAsBitfields','off');

Create a temporary folder (in your system temporary folder) for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Generate Code Without Optimization

Build the model using Embedded Coder®.

slbuild(model)
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### Starting build procedure for: rtwdemo_pack_boolean
### Successful completion of build procedure for: rtwdemo_pack_boolean

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
rtwdemo_pack_boolean  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.11s

View the generated code without the optimization. These lines of code are in
rtwdemo_pack_boolean.h.

hfile = fullfile(cgDir,'rtwdemo_pack_boolean_ert_rtw','rtwdemo_pack_boolean.h');
rtwdemodbtype(hfile,'/* Block signals and states','/* External inputs',1,0);

/* Block signals and states (default storage) for system '<Root>' */
typedef struct {
  boolean_T LogicalOp1;                /* '<Root>/Logical Op1' */
  boolean_T LogicalOp2;                /* '<Root>/Logical Op2' */
  boolean_T LogicalOp5;                /* '<Root>/Logical Op5' */
  boolean_T LogicalOp3;                /* '<Root>/Logical Op3' */
  boolean_T LogicalOp4;                /* '<Root>/Logical Op4' */
  boolean_T RelationalOperator;        /* '<Root>/Relational Operator' */
  boolean_T UnitDelay_DSTATE;          /* '<Root>/Unit Delay' */
} DW;

Enable Optimization

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, select Pack Boolean data into bitfields.

Alternatively, you can use the command-line API to enable the optimization:

set_param(model,'BooleansAsBitfields','on');

Generate Code with Optimization

Build the model using Embedded Coder®.

slbuild(model)

### Starting build procedure for: rtwdemo_pack_boolean
### Successful completion of build procedure for: rtwdemo_pack_boolean

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                   
====================================================================================
rtwdemo_pack_boolean  Code generated and compiled  Generated code was out of date.  
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1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 15.222s

View the generated code with the optimization. These lines of code are in
rtwdemo_pack_boolean.h.

hfile = fullfile(cgDir,'rtwdemo_pack_boolean_ert_rtw','rtwdemo_pack_boolean.h');
rtwdemodbtype(hfile,'/* Block signals and states','/* External inputs',1,0);

/* Block signals and states (default storage) for system '<Root>' */
typedef struct {
  struct {
    uint_T LogicalOp1:1;               /* '<Root>/Logical Op1' */
    uint_T LogicalOp2:1;               /* '<Root>/Logical Op2' */
    uint_T LogicalOp5:1;               /* '<Root>/Logical Op5' */
    uint_T LogicalOp3:1;               /* '<Root>/Logical Op3' */
    uint_T LogicalOp4:1;               /* '<Root>/Logical Op4' */
    uint_T RelationalOperator:1;       /* '<Root>/Relational Operator' */
    uint_T UnitDelay_DSTATE:1;         /* '<Root>/Unit Delay' */
  } bitsForTID0;
} DW;

Selecting Pack Boolean data into bitfields enables model configuration parameter Bitfield
declarator type specifier. To optimize your code further, select uchar_t. However, the optimization
benefit of the Bitfield declarator type specifier setting depends on your choice of target.

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Pack Boolean data into bitfields”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Optimize Generated Code Using Boolean Data for Logical Signals” on page 69-88
• “Replace boolean with Specific Integer Data Type” on page 72-11
• “Data Types Supported by Simulink”
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Optimize Generated Code By Passing Reusable Subsystem
Outputs as Individual Arguments

This example shows how passing reusable subsystem outputs as individual arguments instead of as a
pointer to a structure stored in global memory optimizes the generated code. This optimization
conserves RAM consumption and increases code execution speed by reducing global memory usage
and eliminating data copies from local variables back to global block I/O structures.

Example Model

Consider the model rtwdemo_reusable_sys_outputs. In this model, the reusable subsystem outputs
feed the root outputs of the model.

model = 'rtwdemo_reusable_sys_outputs';
open_system(model);

Generate Code Without This Optimization

Generate code for this model while passing subsystem outputs as a structure reference. Create a
temporary folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_reusable_sys_outputs
### Successful completion of build procedure for: rtwdemo_reusable_sys_outputs

Build Summary

Top model targets built:

Model                         Action                       Rebuild Reason                                    
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=============================================================================================================
rtwdemo_reusable_sys_outputs  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.359s

The code snippet shows portions of rtwdemo_reusable_sys_outputs.c. Notice the global block
I/O structure and in the model step function a data copy from this structure.

cfile = fullfile(cgDir,'rtwdemo_reusable_sys_outputs_ert_rtw',...
'rtwdemo_reusable_sys_outputs.c');
rtwdemodbtype(cfile,'/* Output and update for atomic system',...
'/* Model initialize', 1, 0);

/* Output and update for atomic system: '<Root>/ReusableSubsystem' */
static void ReusableSubsystem(real_T rtu_In1, real_T rtu_In2, real_T rtu_In3,
  DW_ReusableSubsystem *localDW)
{
  /* Gain: '<S1>/Gain' */
  localDW->Gain = 5.0 * rtu_In1;

  /* Gain: '<S1>/Gain1' */
  localDW->Gain1 = 6.0 * rtu_In2;

  /* Gain: '<S1>/Gain2' */
  localDW->Gain2 = 7.0 * rtu_In3;
}

/* Model step function */
void rtwdemo_reusable_sys_outputs_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/ReusableSubsystem' */

  /* Inport: '<Root>/In1' incorporates:
   *  Inport: '<Root>/In2'
   *  Inport: '<Root>/In3'
   */
  ReusableSubsystem(rtU.In1, rtU.In2, rtU.In3, &rtDW.ReusableSubsystem_d);

  /* End of Outputs for SubSystem: '<Root>/ReusableSubsystem' */

  /* Outport: '<Root>/Out1' */
  rtY.Out1 = rtDW.ReusableSubsystem_d.Gain;

  /* Outport: '<Root>/Out2' */
  rtY.Out2 = rtDW.ReusableSubsystem_d.Gain1;

  /* Outport: '<Root>/Out3' */
  rtY.Out3 = rtDW.ReusableSubsystem_d.Gain2;
}

Enable This Optimization

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, set Pass reusable subsystem outputs as to Individual

arguments.
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Alternatively, you can use the command-line API to enable the optimization:

set_param(model, 'PassReuseOutputArgsAs', 'Individual arguments');

Generate Code With This Optimization

With this optimization, the ReusableSubsystem function has three output arguments, which are
direct references to the external outputs. The rtDW global structure no longer exists, and the data
copies from this structure to the rtY (external outputs) structure are not in the generated code.

Build the model.

slbuild(model)

### Starting build procedure for: rtwdemo_reusable_sys_outputs
### Successful completion of build procedure for: rtwdemo_reusable_sys_outputs

Build Summary

Top model targets built:

Model                         Action                       Rebuild Reason                   
============================================================================================
rtwdemo_reusable_sys_outputs  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.966s

The code snippet below is a portion of rtwdemo_reusable_sys_outputs.c. Observe the optimized
code.

rtwdemodbtype(cfile,'/* Output and update for atomic system',...
'/* Model initialize', 1, 0);

/* Output and update for atomic system: '<Root>/ReusableSubsystem' */
static void ReusableSubsystem(real_T rtu_In1, real_T rtu_In2, real_T rtu_In3,
  real_T *rty_Out1, real_T *rty_Out2, real_T *rty_Out3)
{
  /* Gain: '<S1>/Gain' */
  *rty_Out1 = 5.0 * rtu_In1;

  /* Gain: '<S1>/Gain1' */
  *rty_Out2 = 6.0 * rtu_In2;

  /* Gain: '<S1>/Gain2' */
  *rty_Out3 = 7.0 * rtu_In3;
}

/* Model step function */
void rtwdemo_reusable_sys_outputs_step(void)
{
  /* Outputs for Atomic SubSystem: '<Root>/ReusableSubsystem' */

  /* Inport: '<Root>/In1' incorporates:
   *  Inport: '<Root>/In2'
   *  Inport: '<Root>/In3'
   *  Outport: '<Root>/Out1'
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   *  Outport: '<Root>/Out2'
   *  Outport: '<Root>/Out3'
   */
  ReusableSubsystem(rtU.In1, rtU.In2, rtU.In3, &rtY.Out1, &rtY.Out2, &rtY.Out3);

  /* End of Outputs for SubSystem: '<Root>/ReusableSubsystem' */
}

Close the model and cleanup.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Pass reusable subsystem outputs as”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Virtualized Output Ports Optimization” on page 71-15
• “Reduce Global Variables in Nonreusable Subsystem Functions” on page 73-8
• “Data Structures in the Generated Code” on page 34-31
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Convert Data Copies to Pointer Assignments
The code generator optimizes generated code for vector signal assignments by trying to replace for
loop controlled element assignments and memcpy function calls with pointer assignments. Pointer
assignments avoid expensive data copies. Therefore, they use less stack space and offer faster
execution speed than for loop controlled element assignments and memcpy function calls. If you
assign large data sets to vector signals, this optimization can result in significant improvements to
code efficiency.

Configure Model to Optimize Generated Code for Vector Signal Assignments

To apply this optimization:

1 Verify that your target supports the memcpy function.
2 Determine whether your model uses vector signal assignments (such as Y=expression) to move

large amounts of data. For example, your model could use a Selector block to select input
elements from a vector, matrix, or multidimension signal.

3 On the Optimization pane, the Use memcpy for vector assignment parameter, which is on
by default, enables the associated Memcpy threshold (bytes) parameter.

4 Examine the setting of Memcpy threshold (bytes). By default, it specifies 64 bytes as the
minimum array size for which memcpy function calls or pointer assignments can replace for
loops in the generated code. Based on the array sizes in your application's vector signal
assignments, and target environment considerations on the threshold selection, accept the
default value or specify another array size.

Example Model

Consider the following model named rtwdemo_pointer_conversion. This model uses a Switch block to
assign data to a vector signal. This signal then feeds into a Bus Selector block.
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Generate Code without Optimization

1 In the Configuration Parameters dialog box, clear the Use memcpy for vector assignment
parameter.

2 Create a temporary folder for the build and inspection process.
3 Press Ctrl+B to generate code.

### Starting build procedure for: rtwdemo_pointer_conversion
### Successful completion of build procedure for: rtwdemo_pointer_conversion

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
rtwdemo_pointer_conversion  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 18.694s

View the generated code without the optimization. Here is a portion of
rtwdemo_pointer_conversion.c .

/* Model step function */
void rtwdemo_pointer_conversion_step(void)
{
  int32_T i;
  int16_T rtb_dataX[100];
  int16_T rtb_dataY[100];

  /* Switch generated from: '<Root>/Switch' incorporates:
   *  Constant: '<Root>/Constant'
   *  Constant: '<Root>/Constant1'
   *  Constant: '<Root>/Constant2'
   *  Constant: '<Root>/Constant3'
   *  Inport: '<Root>/In1'
   */
  for (i = 0; i < 100; i++) {
    if (rtU.In1) {
      rtb_dataX[i] = rtCP_Constant_Value[i];
      rtb_dataY[i] = rtCP_Constant1_Value[i];
    } else {
      rtb_dataX[i] = rtCP_Constant2_Value[i];
      rtb_dataY[i] = rtCP_Constant3_Value[i];
    }
  }

  /* End of Switch generated from: '<Root>/Switch' */

  /* S-Function (sfix_look1_dyn): '<Root>/Lookup Table Dynamic' incorporates:
   *  Inport: '<Root>/In2'
   *  Outport: '<Root>/Out1'
   */
  /* Dynamic Look-Up Table Block: '<Root>/Lookup Table Dynamic'
   * Input0  Data Type:  Integer        S16
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   * Input1  Data Type:  Integer        S16
   * Input2  Data Type:  Integer        S16
   * Output0 Data Type:  Integer        S16
   * Lookup Method: Linear_Endpoint
   *
   */
  LookUp_S16_S16( &(rtY.Out1), &rtb_dataY[0], rtU.In2, &rtb_dataX[0], 99U);
}

Without the optimization, the generated code contains for loop controlled element assignments.

Enable Optimization and Generate Code
1 In the Configuration Parameter dialog box, select the Use memcpy for vector assignment

parameter.
2 Generate code.

### Starting build procedure for: rtwdemo_pointer_conversion
### Successful completion of build procedure for: rtwdemo_pointer_conversion

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_pointer_conversion  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 14.631s

View the generated code without the optimization. Here is a portion of
rtwdemo_pointer_conversion.c.

/* Model step function */
void rtwdemo_pointer_conversion_step(void)
{
  const int16_T *rtb_dataX_0;
  const int16_T *rtb_dataY_0;

  /* Inport: '<Root>/In1' */
  if (rtU.In1) {
    /* Switch generated from: '<Root>/Switch' incorporates:
     *  Constant: '<Root>/Constant'
     */
    rtb_dataX_0 = &rtCP_Constant_Value[0];

    /* Switch generated from: '<Root>/Switch' incorporates:
     *  Constant: '<Root>/Constant1'
     */
    rtb_dataY_0 = &rtCP_Constant1_Value[0];
  } else {
    /* Switch generated from: '<Root>/Switch' incorporates:
     *  Constant: '<Root>/Constant2'
     */
    rtb_dataX_0 = &rtCP_Constant2_Value[0];
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    /* Switch generated from: '<Root>/Switch' incorporates:
     *  Constant: '<Root>/Constant3'
     */
    rtb_dataY_0 = &rtCP_Constant3_Value[0];
  }

  /* End of Inport: '<Root>/In1' */

  /* S-Function (sfix_look1_dyn): '<Root>/Lookup Table Dynamic' incorporates:
   *  Inport: '<Root>/In2'
   *  Outport: '<Root>/Out1'
   */
  /* Dynamic Look-Up Table Block: '<Root>/Lookup Table Dynamic'
   * Input0  Data Type:  Integer        S16
   * Input1  Data Type:  Integer        S16
   * Input2  Data Type:  Integer        S16
   * Output0 Data Type:  Integer        S16
   * Lookup Method: Linear_Endpoint
   *
   */
  LookUp_S16_S16( &(rtY.Out1), &rtb_dataY_0[0], rtU.In2, &rtb_dataX_0[0], 99U);
}

Because the setting of the Memcpy threshold (bytes) parameter is below the array sizes in the
generated code, the optimized code contains pointer assignments for the vector signal assignments.

See Also
“Use memcpy for vector assignment” | “Memcpy threshold (bytes)”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
• “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 69-48
• “Vector Operation Optimization” on page 69-97
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Reuse Buffers of Different Sizes and Dimensions
You can reuse buffers for matrices that have different sizes and shapes. In the Configuration
Parameters dialog box, you enable this optimization by selecting Reuse buffers of different sizes
and dimensions. This optimization conserves RAM and ROM usage and improves code execution
speed.

Example Model

The model rtwdemo_differentsizereuse contains signals of different sizes and dimensions.

model='rtwdemo_differentsizereuse';
open_system(model);

Generate Code Without Optimization

In the Configuration Parameters dialog box, set Reuse buffers of different sizes and dimension
parameter to off or in the MATLAB Command Window, enter:

set_param('rtwdemo_differentsizereuse','DifferentSizesBufferReuse','off');

Create a folder for the build and inspection process.

currentDir = pwd;
[~,cgDir] = rtwdemodir();

Turn off comments and build the model.

set_param('rtwdemo_differentsizereuse','GenerateComments','off');
slbuild('rtwdemo_differentsizereuse');

### Starting build procedure for: rtwdemo_differentsizereuse
### Successful completion of build procedure for: rtwdemo_differentsizereuse

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                                    
===========================================================================================================
rtwdemo_differentsizereuse  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 21.153s
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View the generated code without the optimization. The D_Work structure is:

hfile = fullfile(cgDir,'rtwdemo_differentsizereuse_ert_rtw',...
    'rtwdemo_differentsizereuse.h');
rtwdemodbtype(hfile,'typedef struct {','} D_Work',1,1);

typedef struct {
  real_T ComplextoRealImag_o1[16384];
  real_T ComplextoRealImag_o2[16384];
  real_T z[3969];
  real_T z_h[3969];
  real_T z_hh[4032];
  real_T z_j[4032];
  real_T z_k[4096];
  real_T z_i[4096];
} D_Work;

The portion of rtwdemo_differentsizereuse.c is:

cfile = fullfile(cgDir,'rtwdemo_differentsizereuse_ert_rtw',...
    'rtwdemo_differentsizereuse.c');
rtwdemodbtype(cfile,'#include "rtwdemo_differentsizereuse.h"',...
    'void rtwdemo_differentsizereuse_initialize(void)',1,0);

#include "rtwdemo_differentsizereuse.h"

D_Work rtDWork;
ExternalInputs rtU;
ExternalOutputs rtY;
static RT_MODEL rtM_;
RT_MODEL *const rtM = &rtM_;
static void Downsample(const real_T rtu_u[16384], real_T rty_z[4096]);
static void DeltaX(const real_T rtu_u[4096], real_T rty_z[4032]);
static void DeltaY(const real_T rtu_u[4032], real_T rty_z[3969]);
static void NoninplaceableSS1(void);
static void NoninplaceableSS2(void);
static void NoninplaceableSS3(void);
static void Downsample(const real_T rtu_u[16384], real_T rty_z[4096])
{
  int32_T tmp;
  int32_T tmp_0;
  int32_T tmp_1;
  int32_T x;
  int32_T y;
  for (x = 0; x < 64; x++) {
    for (y = 0; y < 64; y++) {
      tmp_0 = (y + 1) << 1;
      tmp_1 = (x + 1) << 1;
      tmp = ((tmp_0 - 2) << 7) + tmp_1;
      tmp_0 = ((tmp_0 - 1) << 7) + tmp_1;
      rty_z[x + (y << 6)] = (((rtu_u[tmp - 2] + rtu_u[tmp - 1]) + rtu_u[tmp_0 -
        2]) + rtu_u[tmp_0 - 1]) / 4.0;
    }
  }
}

static void NoninplaceableSS1(void)
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{
  Downsample(rtDWork.ComplextoRealImag_o1, rtDWork.z_i);
  Downsample(rtDWork.ComplextoRealImag_o2, rtDWork.z_k);
}

static void DeltaX(const real_T rtu_u[4096], real_T rty_z[4032])
{
  int32_T tmp;
  int32_T x;
  int32_T y;
  for (x = 0; x < 63; x++) {
    for (y = 0; y < 64; y++) {
      tmp = (y << 6) + x;
      rty_z[x + 63 * y] = fabs(rtu_u[tmp] - rtu_u[tmp + 1]);
    }
  }
}

static void NoninplaceableSS2(void)
{
  DeltaX(rtDWork.z_i, rtDWork.z_j);
  DeltaX(rtDWork.z_k, rtDWork.z_hh);
}

static void DeltaY(const real_T rtu_u[4032], real_T rty_z[3969])
{
  int32_T tmp;
  int32_T x;
  int32_T y;
  for (x = 0; x < 63; x++) {
    for (y = 0; y < 63; y++) {
      tmp = 63 * y + x;
      rty_z[tmp] = fabs(rtu_u[tmp] - rtu_u[(y + 1) * 63 + x]);
    }
  }
}

static void NoninplaceableSS3(void)
{
  DeltaY(rtDWork.z_j, rtDWork.z_h);
  DeltaY(rtDWork.z_hh, rtDWork.z);
}

void rtwdemo_differentsizereuse_step(void)
{
  int32_T i;
  for (i = 0; i < 16384; i++) {
    rtDWork.ComplextoRealImag_o1[i] = rtU.ComplexData[i].re;
    rtDWork.ComplextoRealImag_o2[i] = rtU.ComplexData[i].im;
  }

  NoninplaceableSS1();
  NoninplaceableSS2();
  NoninplaceableSS3();
  for (i = 0; i < 3969; i++) {
    rtY.Out1[i].re = rtDWork.z_h[i];
    rtY.Out1[i].im = rtDWork.z[i];
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  }
}

The D_work structure contains eight global variables for holding the inputs and outputs of
Downsample, DeltaX, and DeltaY. These variables have different sizes.

Generate Code with Optimization

1 In the Configuration Parameters dialog box, verify that Signal storage reuse is selected.
2 Set the Reuse buffers of different sizes and dimensions parameter to on or in the MATLAB

Command Window, enter:

set_param('rtwdemo_differentsizereuse','DifferentSizesBufferReuse','on');

Build the model.

set_param('rtwdemo_differentsizereuse','GenerateComments','off');
slbuild(model);

### Starting build procedure for: rtwdemo_differentsizereuse
### Successful completion of build procedure for: rtwdemo_differentsizereuse

Build Summary

Top model targets built:

Model                       Action                       Rebuild Reason                   
==========================================================================================
rtwdemo_differentsizereuse  Code generated and compiled  Generated code was out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 18.538s

View the generated code without the optimization. The D_Work structure is:

rtwdemodbtype(hfile,'typedef struct {','} D_Work',1,1);

typedef struct {
  real_T z[4096];
  real_T z_h[16384];
  real_T z_o[16384];
} D_Work;

The portion of rtwdemo_differentsizereuse.c is:

cfile = fullfile(cgDir,'rtwdemo_differentsizereuse_ert_rtw',...
    'rtwdemo_differentsizereuse.c');
rtwdemodbtype(cfile,'#include "rtwdemo_differentsizereuse.h"',...
    'void rtwdemo_differentsizereuse_initialize(void)',1,0);

#include "rtwdemo_differentsizereuse.h"

D_Work rtDWork;
ExternalInputs rtU;
ExternalOutputs rtY;
static RT_MODEL rtM_;
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RT_MODEL *const rtM = &rtM_;
static void Downsample(const real_T rtu_u[16384], real_T rty_z[4096]);
static void DeltaX(const real_T rtu_u[4096], real_T rty_z[4032]);
static void DeltaY(const real_T rtu_u[4032], real_T rty_z[3969]);
static void NoninplaceableSS1(void);
static void NoninplaceableSS2(void);
static void NoninplaceableSS3(void);
static void Downsample(const real_T rtu_u[16384], real_T rty_z[4096])
{
  int32_T tmp;
  int32_T tmp_0;
  int32_T tmp_1;
  int32_T x;
  int32_T y;
  for (x = 0; x < 64; x++) {
    for (y = 0; y < 64; y++) {
      tmp_0 = (y + 1) << 1;
      tmp_1 = (x + 1) << 1;
      tmp = ((tmp_0 - 2) << 7) + tmp_1;
      tmp_0 = ((tmp_0 - 1) << 7) + tmp_1;
      rty_z[x + (y << 6)] = (((rtu_u[tmp - 2] + rtu_u[tmp - 1]) + rtu_u[tmp_0 -
        2]) + rtu_u[tmp_0 - 1]) / 4.0;
    }
  }
}

static void NoninplaceableSS1(void)
{
  Downsample(rtDWork.z_h, rtDWork.z);
  Downsample(rtDWork.z_o, &rtDWork.z_h[0]);
}

static void DeltaX(const real_T rtu_u[4096], real_T rty_z[4032])
{
  int32_T tmp;
  int32_T x;
  int32_T y;
  for (x = 0; x < 63; x++) {
    for (y = 0; y < 64; y++) {
      tmp = (y << 6) + x;
      rty_z[x + 63 * y] = fabs(rtu_u[tmp] - rtu_u[tmp + 1]);
    }
  }
}

static void NoninplaceableSS2(void)
{
  DeltaX(rtDWork.z, &rtDWork.z_o[0]);
  DeltaX(&rtDWork.z_h[0], &rtDWork.z[0]);
}

static void DeltaY(const real_T rtu_u[4032], real_T rty_z[3969])
{
  int32_T tmp;
  int32_T x;
  int32_T y;
  for (x = 0; x < 63; x++) {
    for (y = 0; y < 63; y++) {
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      tmp = 63 * y + x;
      rty_z[tmp] = fabs(rtu_u[tmp] - rtu_u[(y + 1) * 63 + x]);
    }
  }
}

static void NoninplaceableSS3(void)
{
  DeltaY(&rtDWork.z_o[0], &rtDWork.z_h[0]);
  DeltaY(&rtDWork.z[0], &rtDWork.z_o[0]);
}

void rtwdemo_differentsizereuse_step(void)
{
  int32_T i;
  for (i = 0; i < 16384; i++) {
    rtDWork.z_h[i] = rtU.ComplexData[i].re;
    rtDWork.z_o[i] = rtU.ComplexData[i].im;
  }

  NoninplaceableSS1();
  NoninplaceableSS2();
  NoninplaceableSS3();
  for (i = 0; i < 3969; i++) {
    rtY.Out1[i].re = rtDWork.z_h[i];
    rtY.Out1[i].im = rtDWork.z_o[i];
  }
}

The D_work structure now contains three global variables instead of eight global variables for
holding the inputs and outputs of Downsample, DeltaX, and DeltaY. The generated code uses these
variables to hold the differently-sized inputs and outputs.

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

Limitations

• If you use a Reusable custom storage class to specify reuse on signals that have different sizes
and shapes, you must select the Reuse buffers of different sizes and dimensions parameter.
Otherwise, the model does not build.

• The code generator does not replace a buffer with a lower priority buffer that has a smaller size.
• The code generator does not reuse buffers that have different sizes and symbolic dimensions.

See Also
“Reuse buffers of different sizes and dimensions”

Related Examples
• “Specify Buffer Reuse by Using Simulink.Signal Objects” on page 71-17
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Remove Reset and Disable Functions from the Generated Code
In this section...
“Example Model” on page 73-28
“Generate Code” on page 73-29
“Enable Optimization” on page 73-29

This example shows how the code generator removes unreachable (dead code) instances of the reset
and disable functions from the generated code for ERT-based systems that include model referencing
hierarchies. Optimizing the generated code to remove unreachable code is a requirement for safety-
critical systems. This optimization also improves execution speed and reduces ROM consumption.

If a model contains blocks with states, the generated code contains reset and disable functions. If the
model is not part of a conditionally executed system, such as an enabled subsystem, the code
generator can remove the disable function because the generated code does not call it. If the model is
not part of a conditionally executed system that can reset states when a control input enables it, the
code generator can remove the reset function because the generated code does not call it.

Example Model
A referenced model, rtwdemo_optionalDisableResetFunc_bot, is in
rtwdemo_optionalDisableResetFunc_top. The referenced model contains two blocks with
states, a Delay block and a Discrete-Time Integrator block.
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Generate Code
1 Open the models. In the Command Window, type rtwdemo_optionalDisableResetFunc_bot

and rtwdemo_optionalDisableResetFunc_top.
2 In your system temporary folder, create a temporary folder for the build and inspection process.
3 Build the model.
4 Open the rtwdemo_optionalDisableResetFunc_top.c and

rtwdemo_optionalDisableResetFunc_bot.c files.

The rtwdemo_optionalDisableResetFunc_bot.c file contains these reset and disable functions.
/* System reset for referenced model: 'rtwdemo_optionalDisableResetFunc_bot' */
void rtwdemo_optionalDisableResetFunc_bot_Reset
  (DW_rtwdemo_optionalDisableResetFunc_bot_f_T *localDW)
{
  /* InitializeConditions for Delay: '<Root>/Delay' */
  localDW->Delay_DSTATE = 0.0;

  /* InitializeConditions for DiscreteIntegrator: '<Root>/Discrete-Time Integrator' */
  localDW->DiscreteTimeIntegrator_DSTATE = 3.0;
}

/* Disable for referenced model: 'rtwdemo_optionalDisableResetFunc_bot' */
void rtwdemo_optionalDisableResetFunc_bot_Disable(real_T *rty_Out1,
  DW_rtwdemo_optionalDisableResetFunc_bot_f_T *localDW)
{
  /* Disable for DiscreteIntegrator: '<Root>/Discrete-Time Integrator' */
  localDW->DiscreteTimeIntegrator_DSTATE = *rty_Out1;
}

The rtwdemo_optionalDisableResetFunc_top_step function does not call the
rtwdemo_optionalDisableResetFunc_bot_Disable function because the model is not part of a
conditionally executed system. The rtwdemo_optionalDisableResetFunc_top_step function
does not call the rtwdemo_optionalDisableResetFunc_bot_Reset function because the model
is not part of a conditionally executed system that can reset states when a control input enables it.

Enable Optimization
1 Open the Model Configuration Parameters dialog box for

rtwdemo_optionalDisableResetFunc_bot.
2 Select Remove Disable Function and Remove Reset Function.
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Open the rtwdemo_optionalDisableResetFunc_bot.c file. The code does not contain the
rtwdemo_optionalDisableResetFunc_bot_Reset function or the
rtwdemo_optionalDisableResetFunc_bot_Disable function.

See Also
“Remove reset function” | “Remove disable function”

Related Examples
• “Optimization Tools and Techniques” on page 69-7
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Optimize Speed and Size of Signal Processing Algorithm by
Using Fixed-Point Data

This model shows a fixed-point version of an acoustic noise canceller.
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Control Operator Type in Generated Code
This example shows how to optimize the generated code by controlling the operator type in the code.
You can generate code with Bitwise or Logical operators or a combination of both for inputs with
Boolean data type. Selecting bitwise operators in the code might improve ROM efficiency when the
code contains bitwise operators.

When you select a value for the Operator to represent Bitwise and Logical Operator blocks
parameter, the generated code maintains the operators as modelled or converts all operators into
either bitwise or logical operators independent of the modeling blocks.

NOTE: This example requires Embedded Coder®.

Example Model

In the model matlab:logicalandbitwise, a Logical AND block connects to a Bitwise AND block.

model = 'logicalandbitwise';
open_system(model);

Generate Code as modeled

Use your system temporary folder for building and inspection process.

currentDir = pwd;

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, set the Operator to represent Bitwise and Logical Operator

blocks parameter to Same as modeled.

Alternatively, use the command-line API to set the parameter value:

set_param(model, 'BitwiseOrLogicalOp', 'Same as modeled');
evalc('slbuild(model)');

View the generated code with operators in the code that matches the modeled blocks. Here is a
portion of logicalandbitwise.c.

cfile = fullfile(currentDir,'logicalandbitwise_ert_rtw','logicalandbitwise.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void logicalandbitwise_step(void)
{
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  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/Input'
   *  Inport: '<Root>/Input1'
   *  Inport: '<Root>/Input2'
   *  Logic: '<Root>/Logical AND'
   *  S-Function (sfix_bitop): '<Root>/Bitwise AND'
   */
  logicalandbitwise_Y.Out1 = logicalandbitwise_U.Input &
    (logicalandbitwise_U.Input1 && logicalandbitwise_U.Input2);
}

The generated code contains both a logical && operator and a bitwise & operator representing the
Logical AND block and Bitwise AND block in the code.

Generate Code with Logical Operators

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, set the Operator to represent Bitwise and Logical Operator

blocks parameter to Logical operator.

Alternatively, use the command-line API to set the parameter value:

set_param(model, 'BitwiseOrLogicalOp', 'Logical operator');
evalc('slbuild(model)');

View the generated code with only logical operators. Here is a portion of logicalandbitwise.c.

cfile = fullfile(currentDir,'logicalandbitwise_ert_rtw','logicalandbitwise.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void logicalandbitwise_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/Input'
   *  Inport: '<Root>/Input1'
   *  Inport: '<Root>/Input2'
   *  Logic: '<Root>/Logical AND'
   *  S-Function (sfix_bitop): '<Root>/Bitwise AND'
   */
  logicalandbitwise_Y.Out1 = (logicalandbitwise_U.Input &&
    (logicalandbitwise_U.Input1 && logicalandbitwise_U.Input2));
}

The generated code contains only the logical && operator. The Bitwise AND block in the model is
converted into the logical && operator in the code.

Generate Code with Bitwise Operators

1 Open the Configuration Parameters dialog box.
2 On the Optimization pane, set the Operator to represent Bitwise and Logical Operator

blocks parameter to Bitwise operator.

Alternatively, use the command-line API to set the parameter value:
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set_param(model, 'BitwiseOrLogicalOp', 'Bitwise operator');
evalc('slbuild(model)');

View the generated code with only bitwise operators. Here is a portion of logicalandbitwise.c.

cfile = fullfile(currentDir,'logicalandbitwise_ert_rtw','logicalandbitwise.c');
rtwdemodbtype(cfile,'/* Model step function ','/* Model initialize function',1, 1);

/* Model step function */
void logicalandbitwise_step(void)
{
  /* Outport: '<Root>/Out1' incorporates:
   *  Inport: '<Root>/Input'
   *  Inport: '<Root>/Input1'
   *  Inport: '<Root>/Input2'
   *  Logic: '<Root>/Logical AND'
   *  S-Function (sfix_bitop): '<Root>/Bitwise AND'
   */
  logicalandbitwise_Y.Out1 = logicalandbitwise_U.Input & (boolean_T)
    (logicalandbitwise_U.Input1 & logicalandbitwise_U.Input2);
}

The generated code contains only the bitwise & operator. The Logical AND block in the model is
converted into the bitwise & operator in the code.

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Operator to represent Bitwise and Logical Operator blocks” | “Optimization Tools and Techniques”
on page 69-7

73 Memory Usage in Embedded Coder

73-34



Code Execution Profiling in Embedded
Coder

• “Code Execution Profiling with SIL and PIL” on page 74-2
• “View and Compare Code Execution Times” on page 74-6
• “Analyze Code Execution Data” on page 74-15
• “Remove Instrumentation Overheads from Execution Time Measurements” on page 74-17
• “Capture Main Profiling Metrics on Target Hardware” on page 74-22
• “Tips and Limitations” on page 74-24
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Code Execution Profiling with SIL and PIL
You can configure a software-in-the-loop (SIL) or processor-in-the-loop (PIL) on page 80-2
simulation to produce execution-time metrics for tasks and functions in your generated code. The
software calculates execution times from data that is obtained through code instrumentation added to
the SIL or PIL application or the generated code under test. You can use the execution-time metrics
to determine whether the generated code meets the requirements for real-time deployment on your
target hardware.

For example, you can perform the following analysis:

1 Identify tasks that require the most time. Tasks are main entry points into the generated code.
For example, the step function for a sample rate or the model_initialize function.

2 In these tasks, investigate code sections that require the most time.
3 Identify variations in execution time over time steps.

If you are trying to reduce execution times, the analysis results help you to focus on the most critical
code sections. To observe performance changes for an updated model, rerun the SIL or PIL
simulation and compare the new metrics against previous metrics.

Note Execution-time measurements depend greatly on the hardware that you use. For reliable
results, collect execution-time metrics using hardware on which you plan to deploy the generated
code, that is, run PIL simulations that execute code on your target hardware. SIL simulations, which
execute code on your host computer, might not produce representative metrics.

When the SIL or PIL simulation is complete, you can:

• View execution-time metrics through a display window or report.
• Use the Simulation Data Inspector to view and compare the variation of execution times over a

simulation.
• Analyze the measurements within the MATLAB environment.

Configure Code Execution Profiling
To configure code execution profiling for a SIL or PIL simulation:

1 In your top model, open the Configuration Parameters dialog box, and select the Code
Generation > Verification pane.

2 Select the Measure task execution time check box.
3 For function execution times, from the Measure function execution times drop-down list,

select one of these options:

• Coarse (referenced models and subsystems only) –– if you want to analyse
generated function code for the main model components.

• Detailed (all function call sites) –– if you want to analyse generated function
code for all blocks in the model.

4 In the Workspace variable field, specify a name. When you run the simulation, the software
generates a variable with this name in the MATLAB base workspace. The variable contains the
execution-time measurements, and is an object of type coder.profile.ExecutionTime.
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If the Data Import/Export > Single simulation output check box is selected, the software
creates the variable in the Simulink.SimulationOutput object that you specify.

5 From the Save options drop-down list, select one of these options:

• Summary data only — If you want to generate only a report and reduce memory usage, for
example, during a long simulation.

• All data — Allows you to generate a report and store execution-time profiles in the base
workspace. After the simulation, you can use methods from the
coder.profile.ExecutionTime and coder.profile.ExecutionTimeSection classes
to retrieve execution-time measurements for every call to each profiled section of code that
occurs during the simulation.

If you select this option, the metrics display window and generated report display the
Simulation Data Inspector icon . When you click the icon, the software imports simulation
results into the Simulation Data Inspector. You can then plot execution times and manage and
compare plots from various simulations.

• Metrics only –– Reduces bandwidth usage for the communication channel between
Simulink and the target application. During the simulation, the software stores on the target
hardware maximum execution times, average execution times, and number of calls. At the end
of the simulation, Simulink uploads the data from the target hardware to your development
computer.

6 Click OK.

For a PIL simulation:

• You must configure a hardware-specific timer. When you set up target connectivity, create a timer
object. This action is not required for a SIL simulation. For more information, see “Set Up PIL
Connectivity by Using target Package” on page 80-49 or “Create PIL Target Connectivity
Configuration for Simulink” on page 80-39.

• You can remove instrumentation overheads from execution times. For more information, see
“Remove Instrumentation Overheads from Execution Time Measurements” on page 74-17.

Control Profiling Granularity
You can control the granularity of execution-time profiling, that is, prevent the addition of code
instrumentation to specific function-call sites. Through the control of profiling granularity, you can:

• Focus on the performance of model components that require improvement. For example, after an
initial run, disable profiling for blocks that require little processing time. This action reduces the
number of items displayed by the profiling report.

• Reduce the code instrumentation overhead. For example, for simple functions, the code
instrumentation overhead can be greater than the execution time of the function code.

To generate execution-time metrics for tasks only, on the Code Generation > Verification pane of
the Configuration Parameters dialog box, select the Measure task execution time check box and
set Measure function execution times to Off.

To generate function execution data for referenced models and atomic subsystems in the top model,
on the Code Generation > Verification pane, select the Measure task execution time check box
and set Measure function execution times to Coarse (referenced models and subsystems
only).
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The generation of function execution data requires the insertion of measurement probes into the
generated code. The software inserts measurement probes for an atomic subsystem only if you set
the Function packaging field (on the Code Generation tab of the Function Block Parameters dialog
box) to either Nonreusable function or Reusable function. If the field is set to Auto, then the
insertion of probes depends on the packaging choice that results from the Auto setting. If the field is
set to Inline, the software does not insert probes.

Note In the generated code, the software wraps each function call with measurement probes except
when:

• The call site cannot be wrapped because of expression folding (see “Minimize Computations and
Storage for Intermediate Results at Block Outputs”).

• The call site is located in the shared utility code (see “Sharing Utility Code”).

To generate function execution times for model reference hierarchies:

1 In the top model, open the Configuration Parameters dialog box, and select the Code
Generation > Verification pane.

2 Select the Measure task execution time check box
3 For each Model block that you want to profile, specify Measure function execution times only

at the reference level for which you require function execution times.

For example, consider a top model that has Model block A, which in turn contains Model block B.

If you want to generate execution times for functions from model B, select Measure task execution
time for the top model and specify Measure function execution times for model B.

These parameters of the top model override the corresponding parameters of referenced models:

• Measure task execution time. If you disable this parameter for the top model, you also disable
function profiling for referenced models.

• Workspace variable
• Save options

To control code execution profiling for a block in a model, for example, a subsystem block, use the
CodeProfilingOverride block parameter:

1 In the Simulink Editor, select the block.
2 In the Command Window, run:

set_param(gcb, 'CodeProfilingOverride', blockParameterValue)
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Use one of these values for blockParameterValue:

• 'off' –– Disables profiling for the block.
• 'on' –– Enables profiling for the block if profiling is enabled for the parent model.
• 'inherit' (default) –– Applies profiling settings of parent block.

Changing the block profiling configuration does not cause the regeneration of production code.

If your top model has a PIL block, the execution profiling settings that apply to the PIL block are the
settings from the original model that you used to create the PIL block. See “Simulation with
Subsystem Blocks” on page 80-17. You cannot use CodeProfilingOverride to control profiling
for a PIL block.

See Also
“Save options” | “Measure function execution times” | “Workspace variable” | “Measure task
execution time”

Related Examples
• “Configure and Run SIL Simulation” on page 80-15
• “SIL/PIL Manager Verification Workflow” on page 80-67
• “View and Compare Code Execution Times” on page 74-6
• “Analyze Code Execution Data” on page 74-15
• “Specify Hardware Timer” on page 80-46
• “View and Analyze Simulation Results”
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View and Compare Code Execution Times
You run a software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation that produces execution-
time metrics for tasks and functions in your generated code. During the simulation, you can use the
Simulation Data Inspector to observe streamed execution times. At the end of the simulation, you can:

• View execution-time metrics for a profiled model component.
• Open a report of execution-time metrics for all profiled components. Through report icons, you

can view, for example, the profiled code section and the execution-time distribution for each
profiled function.

• Use the Simulation Data Inspector to plot and compare execution times from various simulations.

Run SIL Simulation That Generates Execution-Time Metrics
Open the rtwdemo_sil_topmodel model, which has two subsystems CounterTypeA and
CounterTypeB. At the command line, type rtwdemo_sil_topmodel.

To run a SIL simulation that generates execution-time metrics, on the SIL/PIL tab:

1 In the Mode section, select SIL/PIL Simulation Only.
2 In the Prepare section, specify these settings:

a System Under Test — Top model
b SIL/PIL Mode — Software-in-the-Loop (SIL)

3 To measure code execution times for the subsystems, in the Prepare section:

a Click Settings.
b Under Profiling:

• Click the Task Profiling button on. This action selects the Measure task execution
time configuration parameter, which provides execution-time metrics for the task
generated from the top model rtwdemo_sil_topmodel.

• Click the Save Options button until it displays ALL DATA. This action sets the Save
options configuration parameter to All data.

• Click the Functions button until it displays COARSE. This action sets the Measure
function execution times configuration parameter to Coarse (referenced models
and subsystems only), which provides execution-time metrics for the functions
generated from the subsystems CounterTypeA and CounterTypeB.

c Under Coverage, click the Coverage Collection button off, which disables code coverage
analysis. You collect code coverage data separately from profiling data.

d Click the Settings button to open the Configuration Parameters dialog box. On the Data
Import/Export pane, clear Single simulation output.

4 To view streamed execution times during the simulation, open the Simulation Data Inspector. In

the Results section, click .
5 In the Run section, click Run SIL/PIL.
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In the MATLAB base workspace, the simulation generates a variable with the default name,
executionProfile, which stores the execution profiling data. You can specify an alternative name
through the Workspace variable configuration parameter.

Note If you select the Data Import/Export > Single simulation output check box, the simulation
creates the variable in your specified Simulink.SimulationOutput object.

When the simulation is complete, the profiled model components are colored blue and the Code view
displays the generated code. To view execution-time metrics for a profiled component, click the
component. For example, subsystem CounterTypeB.

For top-model SIL or PIL simulations, the Simulink Editor background is also colored blue. When you
click the background, the display window shows execution-time metrics for top-model tasks.

You can trace from a model component to the profiled code section in the Code view. In the Profiling
display window, on a code section row, click the icon . For example, if you click the model
background and then click the icon for the rtwdemo_sil_topmodel_initialize task, you see the
measurement probes around the call site in the SIL application. To see the profiling metrics for the
component, place your cursor on the ellipses above the call site.
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If you click the icon for a function, the call site is highlighted. The Code view displays the average
execution time and number of function calls to the left of the code line. In this example, the maximum
and average times are the same because the initialization function was called only one time.

The Profiling display window also has links to:

• The complete profiling report, which provides execution-time metrics for all profiled code
sections.

• The Simulation Data Inspector, which allows you to plot and compare execution-time
measurements for the profiled code section.

• The execution-time distribution for the profiled code section.
• Pie charts that show the relative execution times of caller and called functions

If you close the model or display window, you can reopen the colored model and display window with
this line command:

>> annotate(executionProfile)

Code Execution Profiling Report
At the end of the simulation, you can open this report through the Profiling display window or with
this line command:

>> report(executionProfile)
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Part 1 provides a summary. Part 2 contains information about profiled code sections. Expand and
collapse profiled sections in part 2 by clicking [+] and [–] respectively. This graphic shows fully
expanded sections.
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The report contains time measurements for:

• The model initialization function initialize.
• A task represented by the step function step [0.1 0].
• Functions generated from the subsystems CounterTypeA and CounterTypeB.

From the Code Execution Profiling Report, you can trace the model component that produces a set of
metrics. For example, in the Section column, if you click the CounterTypeA hyperlink, the Simulink
Editor identifies the subsystem.

By default, the report displays time in nanoseconds (10-9 seconds). You can specify the time unit and
numeric display format. For example, to display time in microseconds (10-6 seconds), use the
following command:
report(executionProfile,...
         'Units', 'Seconds', ...
         'ScaleFactor', '1e-06', ...
         'NumericFormat', '%0.3f')

The report displays time in seconds only if the timer is calibrated, that is, the number of timer ticks
per second is known. On a Windows machine, the software determines this value for a SIL simulation.
On a Linux machine, calibrate the timer manually. For example, if your processor speed is 1 GHz,
specify the number of timer ticks per second:

executionProfile.TimerTicksPerSecond = 1e9;

To view execution-time metrics for a task or function in the Command Window, on the corresponding
row, click .
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>> out.get('executionProfile').Sections(5)
  ExecutionTimeCodeSection with properties:

                            Name: 'CounterTypeA'
                          Number: 5
            ExecutionTimeInTicks: [1×101 uint64]
                 SelfTimeInTicks: [1×101 uint64]
           TurnaroundTimeInTicks: [1×101 uint64]
       TotalExecutionTimeInTicks: 24332
            TotalSelfTimeInTicks: 24332
      TotalTurnaroundTimeInTicks: 24332
     MaximumExecutionTimeInTicks: 502
     MaximumExecutionTimeCallNum: 10
          MaximumSelfTimeInTicks: 502
          MaximumSelfTimeCallNum: 10
    MaximumTurnaroundTimeInTicks: 502
    MaximumTurnaroundTimeCallNum: 10
                        NumCalls: 101
          ExecutionTimeInSeconds: [1×101 double]
                            Time: [101×1 double]

To display measured execution times in the Simulation Data Inspector, click the icon . Use the
Simulation Data Inspector to manage and compare plots from various simulations.

To display the execution-time distribution, click the icon .

In this example, to create the histogram, the software uses these commands:

section=executionProfile.Sections(5);
data=section.ExecutionTimeInSeconds;
histogram(data, 30,'Normalization','probability');

The software creates the histogram only if the number of calls is greater than one.

If the generated code for your model contains nested functions, the simulation generates pie charts
that show the relative execution times of caller and called functions. To display the pie charts, click
the icon  for the caller function. For example, step [0.1 0].
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The pie charts, which display average and maximum execution time distributions, can help you to
identify functions that are bottlenecks in code execution.

Return to the summary in the report. The following table describes the information provided in the
code section profiles.

Column Description
Section Name of task, top model, subsystem, or Model block. Click the link to go

to the model.

With a task, the sample period and sample offset are listed next to the
task name. For example, rtwdemo_sil_topmodel_step [0.1 0]
indicates that the sample period is 0.1 seconds and the sample offset is 0.

Maximum Turnaround
Time (Simulink Real-
Time and support
packages in real-time
mode)

Longest time between start and end of code section. Includes preemption
time.

Average Turnaround
Time (Simulink Real-
Time and support
packages in real-time
mode)

Average time between start and end of code section. Includes preemption
time.

Maximum Execution
Time

Longest time between start and end of code section.

Average Execution Time Average time between start and end of code section.
Maximum Self Time Maximum execution time, excluding time in child sections.
Average Self Time Average execution time, excluding time in child sections.
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Column Description
Calls Number of calls to the code section.

Icon that you click to see the profiled code section in the Code view of the
SIL/PIL app. The code section can be a task or a function.

The specified workspace variable, for example, executionProfile,
must be present in the base workspace.
Icon that you click to display the profiled code section in the Command
Window. Equivalent to executing the command
executionProfile.Sections(i).

The specified workspace variable, for example, executionProfile,
must be present in the base workspace.
Icon that you click to display measured execution times with Simulation
Data Inspector.

The specified workspace variable, for example, executionProfile,
must be present in the base workspace.
Icon that you click to display the execution-time distribution for the
profiled code section.

The specified workspace variable, for example, executionProfile,
must be present in the base workspace.
Icon that you click to display pie charts that show the relative execution
times of caller and called functions in the generated code.

To help you to decide whether you can run the generated code on your target hardware, part 3 of the
code execution profiling report provides CPU workload information:

• Average and maximum CPU time required by each task during a sample period.
• Total CPU usage in a sample period.

The software computes the percentage of CPU time assigned to a task by dividing task execution time
by sample time.

The software generates CPU Utilization only if the number of timer ticks per second is specified.

Compare Code Execution-Time Performance Against Baseline
You can create a code execution profiling report that compares the performance of the generated
code against the performance of a reference version. For example, suppose you want to use the
current execution-time metrics in executionProfile as the baseline for rtwdemo_sil_topmodel.
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1 In the Workspace browser, rename executionProfile to executionProfileBaseline.
2 Run another SIL simulation.
3 To create a report that compares the latest performance against the baseline, in the Command

Window, run:

report(executionProfile,'baseline', executionProfileBaseline)

In part 3 (Comparison with Baseline Performance) and part 4 (CPU Utilization), the report
provides a comparison of execution-time metrics. The differences in execution-time metrics are color-
coded:

• Red — An increase in execution times or CPU usage.
• Green — A decrease in execution times or CPU usage.
• Black — No change.

Visualize Task Scheduling
You can use the Simulation Data Inspector to visualize task scheduling and the order of function calls.
At the end of the simulation, perform one of these actions:

• Run the schedule function. For details, see “Visualize Task Scheduling”
• From the SIL/PIL tab, in the Results gallery, click Generate Schedule. For more information,

see “Analyze Results and Export Test Cases” on page 80-70.

See Also
annotate | report | schedule

Related Examples
• “Code Execution Profiling with SIL and PIL” on page 74-2
• “Analyze Code Execution Data” on page 74-15
• Simulation Data Inspector

More About
• “Tips and Limitations” on page 74-24
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Analyze Code Execution Data
After a SIL or PIL simulation, you can analyze execution-time data using methods from the
coder.profile.ExecutionTime and coder.profile.ExecutionTimeSection classes.

1 Open rtwdemo_sil_topmodel.
2 On the Configuration Parameters > Code Generation > Verification pane, specify profiling

options:

• Select the Measure task execution time check box.
• Specify a Workspace variable, for example, myExecutionProfile.
• From the Save options drop-down list, select All data.

3 Run a SIL simulation.

The software generates the workspace variable myExecutionProfile, an
coder.profile.ExecutionTime object.

To get the total number of code sections that have profiling data, use the Sections method.
>> no_of_Sections = myExecutionProfile.Sections

no_of_Sections = 

  1×2 ExecutionTimeTaskSection array with properties:

    Name
    Number
    ExecutionTimeInTicks
    SelfTimeInTicks
    TurnaroundTimeInTicks
    TotalExecutionTimeInTicks
    TotalSelfTimeInTicks
    TotalTurnaroundTimeInTicks
    MaximumExecutionTimeInTicks
    MaximumExecutionTimeCallNum
    MaximumSelfTimeInTicks
    MaximumSelfTimeCallNum
    MaximumTurnaroundTimeInTicks
    MaximumTurnaroundTimeCallNum
    NumCalls
    ExecutionTimeInSeconds
    Time

To get the coder.profile.ExecutionTimeSection object for a profiled code section, use the
method Sections.
>> FirstSectionProfile = myExecutionProfile.Sections(1)
SecondSectionProfile = myExecutionProfile.Sections(2)

FirstSectionProfile = 

  ExecutionTimeTaskSection with properties:

                            Name: 'rtwdemo_sil_topmodel_initialize'
                          Number: 1
            ExecutionTimeInTicks: 1188
                 SelfTimeInTicks: 1188
           TurnaroundTimeInTicks: 1188
       TotalExecutionTimeInTicks: 1188
            TotalSelfTimeInTicks: 1188
      TotalTurnaroundTimeInTicks: 1188
     MaximumExecutionTimeInTicks: 1188
     MaximumExecutionTimeCallNum: 1
          MaximumSelfTimeInTicks: 1188
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          MaximumSelfTimeCallNum: 1
    MaximumTurnaroundTimeInTicks: 1188
    MaximumTurnaroundTimeCallNum: 1
                        NumCalls: 1
          ExecutionTimeInSeconds: 5.4000e-07
                            Time: 0

SecondSectionProfile = 

  ExecutionTimeTaskSection with properties:

                            Name: 'rtwdemo_sil_topmodel_step [0.1 0]'
                          Number: 2
            ExecutionTimeInTicks: [1×101 uint64]
                 SelfTimeInTicks: [1×101 uint64]
           TurnaroundTimeInTicks: [1×101 uint64]
       TotalExecutionTimeInTicks: 70316
            TotalSelfTimeInTicks: 70316
      TotalTurnaroundTimeInTicks: 70316
     MaximumExecutionTimeInTicks: 2448
     MaximumExecutionTimeCallNum: 2
          MaximumSelfTimeInTicks: 2448
          MaximumSelfTimeCallNum: 2
    MaximumTurnaroundTimeInTicks: 2448
    MaximumTurnaroundTimeCallNum: 2
                        NumCalls: 101
          ExecutionTimeInSeconds: [1×101 double]
                            Time: [101×1 double]

Use coder.profile.ExecutionTimeSection methods to extract profiling information for a
particular code section. For example, use Name to obtain the name of a profiled task.
>> name_of_section = SecondSectionProfile.Name

name_of_section =

rtwdemo_sil_topmodel_step [0.1 0]

If the timer is uncalibrated and you know the timer rate, for example 2.2 GHz, you can use the
coder.profile.ExecutionTime method TimerTicksPerSecond to calibrate the timer:
>> myExecutionProfile.TimerTicksPerSecond = 2.2e9;
>> SecondSectionProfile = myExecutionProfile.Sections(2);

See Also

Related Examples
• “Code Execution Profiling with SIL and PIL” on page 74-2
• “View and Compare Code Execution Times” on page 74-6
• “Tips and Limitations” on page 74-24
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Remove Instrumentation Overheads from Execution Time
Measurements

To improve execution-time profiling of generated code that runs on deterministic hardware, you can
run processor-in-the-loop (PIL) simulations that automatically filter the overheads associated with
code instrumentation. You can use the target hardware to estimate the average overhead value or you
can specify the value manually.

Note By default, the software filters the execution times of AUTOSAR Runtime Environment (RTE)
code and functions that run within Simulink, for example, Function Caller blocks.

Approach for Estimating and Removing Instrumentation Overhead
When you set up target connectivity for PIL simulations, you can specify objects or functions for
estimating and removing instrumentation overheads from execution-time measurements.

You can:

• Set up a benchmark program that Simulink runs a specified number of times at the start of a PIL
simulation. The benchmark program estimates the overheads for the timer API and for timer
freezing and unfreezing, task, and function instrumentation code. Simulink obtains average values
for the instrumentation overheads.

• Manually specify instrumentation overhead values.

During the PIL simulation, Simulink subtracts the instrumentation overhead values from the
execution-time measurements. The Simulation Data Inspector and the code execution profiling report
display the corrected measurement values.

This figure shows how the uncorrected and corrected timer values correspond to invocations of code
sections.

The corrected timer value excludes execution time associated with instrumentation code, RTE code,
and function code that runs within Simulink.

To estimate and remove instrumentation overheads from execution-time measurements:
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• If PIL connectivity is set up by using the target package, use overhead classes from the package.
• If PIL connectivity is set up by using the rtw.connectivity.Config class, use functions from

the class.

Remove Instrumentation Overheads by Using target Package
To provide the software with instrumentation overhead values, use one of these methods:

• Set up the benchmark program that estimates overhead values.
• Using overhead classes, manually specify overhead values.

Set Up Benchmark Program

When you set up target connectivity on page 80-49, implement these steps:

1 Retrieve the target.Processor and target.Timer objects.

processor = target.get('Processor', myProcessorObjectId);
timer = target.get('Timer', myTimerObjectId);

2 Create a target.ProfilingTaskOverhead object.

taskOverhead = target.create('ProfilingTaskOverhead', ...
                             'Name', 'Timer Task Overhead');
taskOverhead.Counter = timer;
taskOverhead.MinimumBenchmarkIterations = 150;

3 Associate the overhead values with the processor.

processor.Overheads = taskOverhead;

Specify Overhead Values

When you set up target connectivity on page 80-49, create overhead class objects and use the
Value property to specify your value for the corresponding instrumentation overhead.

1 Retrieve the target.Processor and target.Timer objects.

processor = target.get('Processor', myProcessorObjectId);
timer = target.get('Timer', myTimerObjectId);

2 Create a target.ProfilingTaskOverhead object.

taskOverhead = target.create('ProfilingTaskOverhead',...
                             'Name', 'Timer Task Overhead');
taskOverhead.Value = 10;
taskOverhead.Counter = timer;

3 Create a target.ProfilingFunctionOverhead object.

functionOverhead = target.create('ProfilingFunctionOverhead',...
                            'Name', 'Timer Function Overhead');
functionOverhead.Value = 20;
functionOverhead.Counter = timer;

4 Create a target.ProfilingFreezingOverhead object.

freezingOverhead = target.create('ProfilingFreezingOverhead',...
                                 'Name', 'Timer Freezing Overhead');
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freezingOverhead.Value = 30;
freezingOverhead.Counter = timer;

5 Associate the overhead values with the processor.

processor.Overheads = ...
 [taskOverhead, functionOverhead, freezingOverhead];

Remove Instrumentation Overheads by Using Functions from
rtw.connectivity.Config
The rtw.connectivity.Config class provides these functions for the removal of instrumentation
overheads.

Function Description
activateOverheadFiltering obj.activateOverheadFiltering (value);

activates filtering of instrumentation overheads if
value is true. Deactivates overhead filtering if
value is false.

isOverheadFilteringActive obj.isOverheadFilteringActive returns
true if instrumentation overhead filtering is
activated. Otherwise, returns false.

runOverheadBenchmark obj.runOverheadBenchmark(value); runs a
benchmark program if value is true. Does not
run the benchmark program if value is false.

isOverheadBenchmarkExecuted obj.isOverheadBenchmarkExecuted; returns
true if execution of benchmark program is
complete. Otherwise, returns false.

setOverheadBenchmarkSteps obj.setOverheadBenchmarkSteps(steps);
specifies number of steps for benchmark
program.

getOverheadBenchmarkSteps steps = obj.getOverheadBenchmarkSteps
returns the number of specified steps for the
benchmark program.

setOverheads obj.setOverheads(taskInstrumentationOv
erhead,
functionInstrumentationOverhead,
freezingInstrumentation); specifies the
overhead values for task, function, and freezing
instrumentation respectively.

getOverheads [taskInstrumentationOverhead,
functionInstrumentationOverhead,
freezingInstrumentation] =
obj.getOverheads; returns overhead values
for task, function, and freezing instrumentation
respectively.

When you set up target connectivity on page 80-39 for PIL simulations, configure the removal of the
instrumentation overheads through an rtw.connectivity.Config subclass. For example, this
code shows how you can run the benchmark program.
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classdef overheadConnectivityConfig < rtw.connectivity.Config
  methods
    function this = customConnectivityConfig(componentArgs)
            
      % Create builder
      targetApplicationFramework = ...
        mypil.TargetApplicationFramework(componentArgs);
      builder = rtw.connectivity.MakefileBuilder(componentArgs, ...
        targetApplicationFramework, '');
            
      % Create launcher
      launcher = mypil.Launcher(componentArgs, builder);
            
      % Set up communication       
      hostCommunicator = rtw.connectivity.RtIOStreamHostCommunicator(...
                         componentArgs, ...
                         launcher, ...
                         rtiostreamLibTCPIP);     

      % Call super class constructor to register components
        this@rtw.connectivity.Config(componentArgs,...
                                     builder,...
                                     launcher,...
                                     hostCommunicator);
            
      % Register hardware-specific timer, which enables
      % code execution profiling. This example uses a 
      % timer for the host platform.
      timer = coder.profile.crlHostTimer();
      this.setTimer(timer);

      % Specify removal of profiling instrumentation overheads
      this.activateOverheadFiltering(true);
      this.runOverheadBenchmark(true);
      this.setOverheadBenchmarkSteps(50);

    end
  end
end

Instead of running the benchmark program, you can use setOverheads to provide your values for
instrumentation overheads.

    ...

    % Remove instrumentation overhead using manually specified values
    this.activateOverheadFiltering(true);
    this.setOverheads (taskInstrumentationOverhead, ...
      functionInstrumentationOverhead, freezingInstrumentation);

    ...

Retrieve Benchmark Results
When a PIL simulation is complete, you can retrieve benchmark results from the variable that you
specify in the Code Generation > Verification > Workspace variable field
(CodeExecutionProfileVariable), for example, myExecutionProfile.
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benchmarkResults = myExecutionProfile.getOverheadBenchmarkData();

benchmarkResults is a structure that contains code instrumentation overhead values.

>> benchmarkResults
 ans = 
 struct with fields:
 TimestampOverhead: [1×1 struct]
 TaskOverhead: [1×1 struct]
 FunctionOverhead: [1×1 struct]
 FreezingOverhead: [1×1 struct]

>> benchmarkResults.TaskOverhead
 ans = 
 struct with fields:
 Data: [1×100 uint64]
 NumSamples: 100
 Average: 45.2800

See Also
rtw.connectivity.Config | target | target.ProfilingFreezingOverhead |
target.ProfilingFunctionOverhead | target.ProfilingTaskOverhead

More About
• “Set Up PIL Connectivity by Using target Package” on page 80-49
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Code Execution Profiling with SIL and PIL” on page 74-2
• “View and Compare Code Execution Times” on page 74-6
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Capture Main Profiling Metrics on Target Hardware
For code execution profiling, to reduce the communication channel bandwidth usage during a
software-in-the-loop (SIL) simulation, processor-in-the-loop simulation (PIL), or XCP external mode
simulation, you can capture and store only these profiling metrics on the target hardware:

• Maximum execution time of code section
• Average execution time of code section
• Number of calls to code section

At the end of the simulation, Simulink uploads the metrics from the target hardware to your
development computer.

To run a SIL simulation that generates only the main execution-time metrics:

1 Open the rtwdemo_sil_topmodel model, which has two subsystems CounterTypeA and
CounterTypeB.

2 On the SIL/PIL tab, in the Mode section, select SIL/PIL Simulation Only.
3 In the Prepare section, specify these settings:

a System Under Test — Top model
b SIL/PIL Mode — Software-in-the-Loop (SIL)

4 To measure code execution times for the subsystems:

a
Click .

b In the Configuration Parameters dialog box, select Measure task execution time, which
provides execution-time metrics for the task generated from the top model
rtwdemo_sil_topmodel.

c Set Measure function execution times to Coarse (referenced models and
subsystems only), which provides execution-time metrics for the functions generated
from the subsystems CounterTypeA and CounterTypeB.

d Specify a Workspace variable, for example, executionProfile. If the Data Import/
Export > Single simulation output check box is selected, the software creates the
variable in the Simulink.SimulationOutput object that you specify.

e From the Save options drop-down list, select Metrics only.
f Click OK.

5 In the Prepare section, click Settings. Under Coverage, click the Coverage Collection button
off.

6 In the Run section, click Run SIL/PIL.

The simulation generates the variable executionProfile in the MATLAB base workspace.

To open the code execution profiling report, in the Profiling window, click the displayed link. In
section 2, the report displays the profiled code sections as a flattened list.
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The software cannot extract the hierarchy of calls to code sections because this information is not
stored on the target hardware.

Overhead filtering on page 74-17 is not supported when Save options is set to Metrics only.

See Also
“Save options” | “Measure function execution times” | “Workspace variable” | “Measure task
execution time”

Related Examples
• “Configure and Run SIL Simulation” on page 80-15
• “View and Compare Code Execution Times” on page 74-6
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Tips and Limitations

Triggered Model Block
Consider the case where a triggered Model block is configured to run in the SIL or PIL simulation
mode. The software generates one execution-time measurement each time the referenced model is
triggered to run. If there are multiple triggers in a single time step, the software generates multiple
measurements for the triggered Model block. Conversely, if there is no trigger in a given time step,
the software generates no time measurements.

Outliers in Execution-Time Profiles
When you run a SIL simulation with execution time profiling enabled, you might see spikes in
execution-time measurements.

The spikes are due to process preemption that occurs with a multitasking host operating system. If
the operating system preempts the SIL process and runs another process, the measured execution
time includes the time during which the SIL process is suspended. With a PIL simulation, you do not
see spikes because code execution on the target is not preempted.

Counter wrapping produces execution-time measurements that are smaller than expected. For SIL,
the counter wraps when an execution-time period is greater than 264 ticks (232 ticks if the MEX
compiler is LCC). For PIL, the wrapping point depends on the timer you specify and can be 28, 216,
232, or 264 ticks.

Consider a PIL example where the timer frequency is 20 MHz. For a 32-bit timer, wrapping occurs
when the execution-time period is greater than 1/(20e6)*(2^32-1), that is, 214.7 s. However, for a
16-bit timer, the point at which wrapping occurs is 0.0033 s.
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For a real-time, multi-core application, the software accommodates synchronization discrepancies
when recording timer values for different cores, which effectively reduces the timer measurement
range.

Hardware-Specific Timer
If your target configuration does not already specify a timer, create a timer object that provides
details of the hardware-specific timer and associated source files:

• For SIL simulation, the timer word length is 64 bits.
• For PIL simulation, specify an unsigned 8-, 16-, 32-, or 64-bit timer. For more information, see

“Specify Hardware Timer” on page 80-46.

Task Context Switching Due to Preemption
Profiling instrumentation is intrusive and affects the quantity that it is meant to measure. Therefore,
the design goal is to maximize code understanding with a minimum of instrumentation. For example,
with a real-time system, there can be task context switches due to preemption. These context
switches are not explicitly instrumented. To record the start and end of each task, the software must
infer context switches from instrumentation. As a result, the software reports behavior that is an
estimate. The estimate is subject to error because of incomplete instrumentation within the kernel.

In some cases, when the software cannot accurately determine behavior, the software generates a
warning:
Warning: Analysis unsuccessful for one or more profiling data points. ...

For example, the software might generate this warning when not all mutex take system calls
(associated with rate transitions) are instrumented. In the case of Simulink Real-Time, this situation
might arise if you generate code for a model reference hierarchy without enabling function profiling
for all referenced models (set_param(model, 'CodeProfilingInstrumentation', 'on')). If
a mutex take system call is not instrumented, a task context switch might occur that is not visible to
the execution profiling analysis.

In other cases, although the software cannot accurately determine behavior, the software does not
generate a warning.

Subsystem Code Reuse
You cannot generate execution-time profiles for function call sites within subsystem code that is
reused across a model or multiple models. For information about subsystem code reuse, see
“Generate Reusable Code from Library Subsystems Shared Across Models”.

Cannot Load Execution-Time Measurements from Previous Release
You cannot load execution-time measurements saved with a previous release. For example, using
R2014a, you save workspace variables to a MAT-file. One of the workspace variables contains
execution-time measurements. In R2015b, if you try to load the MAT-file, you see this error:

Format of execution profiling data is invalid. This error can occur if 
you load data from a previous release. Loading data from a previous 
release is not supported.
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Code Execution Profiling for MATLAB
Coder

• “Execution Time Profiling for SIL and PIL” on page 75-2
• “Generate Execution Time Profile” on page 75-3
• “View Execution Times” on page 75-4
• “Analyze Execution Time Data” on page 75-7
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Execution Time Profiling for SIL and PIL
During a software-in-the-loop (SIL) or processor-in-the-loop (PIL) execution, you can produce a profile
of execution times for code generated from entry-point functions. The software calculates execution
times from data that is obtained through instrumentation probes added to the SIL or PIL application.

Use the execution time profile to check whether your code runs within the required time on your
target hardware:

• If code execution overruns, look for ways to reduce execution time.
• If your code easily meets time requirements, consider enhancing functionality to exploit the

unused processing power.

At the end of the SIL or PIL execution, you can:

• View a report of code execution times.
• Use the Simulation Data Inspector to view and compare plots of function execution times.
• Access and analyze execution time profiling data.

See Also

Related Examples
• “Generate Execution Time Profile” on page 75-3
• “View Execution Times” on page 75-4
• “Analyze Execution Time Data” on page 75-7
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Generate Execution Time Profile
Before running a software-in-the-loop (SIL) or processor-in-the-loop (PIL) execution, enable execution
time profiling:

1 To open the MATLAB Coder app, on the MATLAB Toolstrip Apps tab, under Code Generation,
click the app icon.

2
To open your project, click  and then click Open existing project. Select the project.

3 On the Generate Code page, click Verify Code.
4 Select the Enable entry point execution profiling for SIL/PIL check box.
5 If you also want to generate execution time profiles for functions that are called within entry-

point functions, select the Enable function execution profiling check box.

Note Function profiling does not support the OpenMP library. Before you generate code, on the
Generate Code page, click the arrow next to Generate. Then, click More Settings. Under
Advanced, set Enable OpenMP library if possible to No.

On a Mac operating system, SIL and PIL execution does not support execution-time profiling for
functions that are called within entry-point functions.

Or, from the Command Window, specify properties of your coder.EmbeddedCodeConfig object. For
example:

% Enable entry point execution profiling
config.CodeExecutionProfiling = true;

% Enable function execution profiling
config.CodeProfilingInstrumentation = true;

% Disable OpenMP
config.EnableOpenMP = false;

See Also

Related Examples
• “Software-in-the-Loop Execution with the MATLAB Coder App” on page 82-4
• “Processor-in-the-Loop Execution with the MATLAB Coder App” on page 82-20
• “View Execution Times” on page 75-4
• “Analyze Execution Time Data” on page 75-7

More About
• “Execution Time Profiling for SIL and PIL” on page 75-2
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View Execution Times
When you run a SIL or PIL execution with execution time profiling enabled, the software generates a
message in the Test Output tab. For example:
Current plot held
### Starting SIL execution for 'kalman01'
    To terminate execution: clear kalman01_sil
    Execution profiling data is available for viewing. Open Simulation Data Inspector.
    Execution profiling report available after termination.
Current plot released

To observe streamed execution times while the execution runs, click the Simulation Data
Inspector link.

To open the code execution profiling report:

1 Click the Stop SIL Verification link.

The software terminates the execution process and displays a new link.
### Stopping SIL execution for 'kalman01'
    Execution profiling report: report(getCoderExecutionProfile('kalman01'))

2 Click the new link.

The report provides:

• A summary.
• Information about profiled code sections, which includes time measurements for:

• The entry_point_fn_initialize function, for example, kalman01_initialize.
• The entry-point function, for example, kalman01.
• The entry_point_fn_terminate function, for example, kalman01_terminate.

• Definitions for metrics.
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By default, the report displays time in nanoseconds (10-9 seconds). You can specify the time unit and
numeric display format. For example, to display time in microseconds (10-6 seconds), use the report
command:

% Create workspace variable
executionProfile=getCoderExecutionProfile('kalman01');

report(executionProfile, ...
       'Units', 'Seconds', ...
       'ScaleFactor', '1e-06', ...
       'NumericFormat', '%0.3f')

The report displays time in seconds only if the timer is calibrated, that is, the number of timer ticks
per second is established. On a Windows machine, the software determines this value for a SIL
simulation. On a Linux machine, you must manually calibrate the timer. For example, if your
processor speed is 1 GHz, specify the number of timer ticks per second:

executionProfile.TimerTicksPerSecond = 1e9;

To view execution-time metrics for a code section in the Command Window, on the corresponding
row, click the icon .

To display measured execution times, click the Simulation Data Inspector icon . You can use the
Simulation Data Inspector to manage and compare plots from various executions.

To display the execution-time distribution, click the icon .

In this example, to create the histogram, the software uses these commands:

executionProfile=getCoderExecutionProfile('kalman01')
section=executionProfile.Sections(2);
data=section.ExecutionTimeInSeconds;
histogram(data, 30,'Normalization','probability');

The software creates the histogram only if the number of calls to the function is greater than one.

The following table lists the information provided in the code section profiles.

Column Description
Section Name of function from which code is generated.
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Column Description
Maximum Execution
Time

Longest time between start and end of code section.

Average Execution
Time

Average time between start and end of code section.

Maximum Self Time Maximum execution time, excluding time in child sections.
Average Self Time Average execution time, excluding time in child sections.
Calls Number of calls to the code section.

Icon that you click to display the profiled code section.

Icon that you click to display measured execution times with Simulation Data
Inspector.
Icon that you click to display the execution-time distribution for the profiled
code section.

See Also

Related Examples
• “Generate Execution Time Profile” on page 75-3
• “Analyze Execution Time Data” on page 75-7
• Simulation Data Inspector
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Analyze Execution Time Data
After a software-in-the-loop (SIL) or processor-in-the-loop (PIL) execution, you can analyze execution-
time data using methods from the coder.profile.ExecutionTime and
coder.profile.ExecutionTimeSection classes.

In the following example, you run a SIL execution and apply supplied methods to execution-time data.

Extract Execution Time Data for Kalman Estimator Code
1 Run SIL execution to generate execution time data

Copy MATLAB code to your working folder.

src_dir = ...
    fullfile(docroot,'toolbox','coder','examples','kalman');

copyfile(fullfile(src_dir,'kalman01.m'), '.')
copyfile(fullfile(src_dir,'test01_ui.m'), '.')
copyfile(fullfile(src_dir,'plot_trajectory.m'), '.')
copyfile(fullfile(src_dir,'position.mat'), '.')

For a description of the Kalman estimator, see “Generate C Code at the Command Line”.

Create a coder.EmbeddedCodeConfig object.

config = coder.config('lib');
config.GenerateReport = true; % HTML report

Configure the object for SIL and enable execution time profiling.

config.VerificationMode = 'SIL';
config.CodeExecutionProfiling = true;

If you want to generate execution time profiles for functions that are called within entry-point
functions, you must also disable the OpenMP library.

config.CodeProfilingInstrumentation = true;
config.EnableOpenMP = false;

On a Mac operating system, SIL and PIL execution does not support execution-time profiling for
functions that are called within entry-point functions.

Generate library code for the kalman01 MATLAB function and the SIL interface.

codegen('-config', config, '-args', {zeros(2,1)}, 'kalman01');

Run the MATLAB test file test01_ui with kalman01_sil. kalman01_sil is the SIL interface
for kalman01.

coder.runTest('test01_ui', ['kalman01_sil.' mexext]);

You see the following message.
### Starting SIL execution for 'kalman01'
    To terminate execution: clear kalman01_sil
    Execution profiling data is available for viewing. Go to Simulation Data Inspector.
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    Execution profiling report available after termination.
Current plot released

Terminate the SIL execution process. Click the link clear kalman01_sil.
 ### Stopping SIL execution for 'kalman01'
    Execution profiling report: report(getCoderExecutionProfile('kalman01'))

2 Create workspace variable that holds execution time data

Use the getCoderExecutionProfile function to create a workspace variable that holds
execution time profiling data.

executionProfile=getCoderExecutionProfile('kalman01');
3 Extract code sections

Use the Sections method.

allSections = executionProfile.Sections

The software displays the number of code sections and a list of properties.
allSections = 

  1x3 ExecutionTimeTaskSection array with properties:

    Name
    Number
    ExecutionTimeInTicks
    SelfTimeInTicks
    TurnaroundTimeInTicks
    TotalExecutionTimeInTicks
    TotalSelfTimeInTicks
    TotalTurnaroundTimeInTicks
    MaximumExecutionTimeInTicks
    MaximumExecutionTimeCallNum
    MaximumSelfTimeInTicks
    MaximumSelfTimeCallNum
    MaximumTurnaroundTimeInTicks
    MaximumTurnaroundTimeCallNum
    NumCalls
    ExecutionTimeInSeconds
    Time

4 Extract execution time data from specific code section

Specify the code section that you want to examine.

secondSectionProfile = executionProfile.Sections(2)

The software displays profile data for the code section.
secondSectionProfile = 

  ExecutionTimeTaskSection with properties:

                            Name: 'kalman01'
                          Number: 2
            ExecutionTimeInTicks: [1x300 uint64]
                 SelfTimeInTicks: [1x300 uint64]
           TurnaroundTimeInTicks: [1x300 uint64]
       TotalExecutionTimeInTicks: 6641016
            TotalSelfTimeInTicks: 6641016
      TotalTurnaroundTimeInTicks: 6641016
     MaximumExecutionTimeInTicks: 48864
     MaximumExecutionTimeCallNum: 158
          MaximumSelfTimeInTicks: 48864
          MaximumSelfTimeCallNum: 158
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    MaximumTurnaroundTimeInTicks: 48864
    MaximumTurnaroundTimeCallNum: 158
                        NumCalls: 300
          ExecutionTimeInSeconds: [1x300 double]
                            Time: [300x1 double]

You can extract specific properties, for example, the name of a profiled function.

nameOfSection = secondSectionProfile.Name

The software displays the name.
nameOfSection =

'kalman01'

The following table lists the information that you can extract from each code section.

Property Description
Name Name of entry-point function
Number Code section number
ExecutionTimeInTicks Vector of execution times, measured in timer ticks. Each element

contains the difference between the timer reading at the start and
at the end of the code section. The data type is the same data type
as the data type of the timer used on the target, which allows you
to infer the maximum range of the timer measurements.

SelfTimeInTicks Vector of timer tick numbers. Each element contains the number
of ticks recorded for the code section, excluding the time spent in
calls to child functions.

TurnaroundTimeInTicks Vector of timer tick numbers. Each element contains the number
of ticks recorded between the start and the finish of the code
section. Unless the code is preempted, this number is the same
number as the execution time.

TotalExecutionTimeInTicks Total number of timer ticks recorded for the code section over the
entire execution.

TotalSelfTimeInTicks Total number of timer ticks recorded for the profiled code section
over the entire execution. However, this number excludes the time
spent in calls to child functions.

TotalTurnaroundTimeInTicks Total number of timer ticks recorded between the start and the
finish of the profiled code section over the entire execution. Unless
the code is preempted, this number is the same as the total
execution time.

MaximumExecutionTimeInTicks Maximum number of timer ticks recorded for a single invocation of
the code section over the execution.

MaximumExecutionTimeCallNum Number of call in which MaximumExecutionTimeInTicks
occurs.

MaximumSelfTimeInTicks Maximum number of timer ticks recorded for a single code section
invocation, but excluding the time spent in calls to child functions.

MaximumSelfTimeCallNum Number of call in which MaximumSelfTimeInTicks occurs.
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Property Description
MaximumTurnaroundTimeInTicks Maximum number of timer ticks recorded between the start and

the finish of a single invocation of the profiled code section over
the execution. Unless the code is preempted, this time is the same
as the maximum execution time.

MaximumTurnaroundTimeCallNum Number of call in which MaximumTurnaroundTimeInTicks
occurs.

NumCalls Total number of calls to the code section over the entire execution.
ExecutionTimeInSeconds Vector of execution times, measured in seconds. Each element

contains the difference between the timer reading at the start and
at the end of the code section. Produced only if
TimerTicksPerSecond is set.

Time Vector of execution time measurements for the code section.

See Also

Related Examples
• “Generate Execution Time Profile” on page 75-3
• “View Execution Times” on page 75-4
• Simulation Data Inspector

75 Code Execution Profiling for MATLAB Coder

75-10



Verification

11





Simulation and Code Comparison in
Simulink Coder

76



Simulation and Code Comparison
In this section...
“Configure Signal Data for Logging” on page 76-2
“Log Simulation Data” on page 76-3
“Run Executable and Load Data” on page 76-4
“Visualize and Compare Results” on page 76-5
“Compare States for Simulation and Code Generation” on page 76-6

This example shows how to verify the answers computed by code generated from the
slexAircraftExample model. It shows how to capture and compare two sets of output data.
Simulating the model produces one set of output data. Executing the generated code produces a
second set of output data.

Note To obtain a valid comparison between model output and the generated code, use the same
Solver selection and Step size for the simulation run and the build process.

Configure Signal Data for Logging
Configure the model for logging and recording signal data.

1 Make sure that slexAircraftExample is closed. Clear the base workspace to eliminate the
results of previous simulation runs. In the Command Window, type:

clear

The clear operation clears variables created during previous simulations and all workspace
variables, some of which are standard variables that the slexAircraftExample model
requires.

2 In the Command Window, enter slexAircraftExample to open the model.
3 In the model window, choose File > Save As, navigate to the working folder, and save a copy of

the slexAircraftExample model as myAircraftExample.
4 Set up your model to log signal data for signals: Stick, alpha,rad, and q, rad/sec. For each

signal:

a Right-click the signal. From the context menu, select Properties.
b In the Signal Properties dialog box, select Log signal data.
c In the Logging name section, from the drop-down list, select Custom.
d In the text field, enter the logging name for the corresponding signal.

Signal Name Logging Name
Stick Stick_input
alpha,rad Alpha
q, rad/sec Pitch_rate

e Click Apply and OK.
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For more information, see “Export Signal Data Using Signal Logging”.
5 In the Configuration Parameters dialog box:

a Set Type to Fixed-step.
b Set Format to Structure with time.
c Clear the States check box.
d Select the Signal logging check box.
e Select the Record logged workspace data in Simulation Data Inspector check box.

6 Save the model.

Proceed to “Log Simulation Data” on page 76-3.

Log Simulation Data
Run the simulation, log the signal data, and view the data in the Simulation Data Inspector.

1 Run the model. When the simulation is done, on the Simulink Editor toolbar, the Simulation
Data Inspector button is highlighted to indicate that new simulation output is available in the
Simulation Data Inspector.

2 Click the Simulation Data Inspector button to open the Simulation Data Inspector.
3 Group the signals:

a On the Visualize tab, click Group Signals.
b In the Group Signals dialog box, select Data Hierarchy from the Then By list.

c Click OK.
4 Click the logsout expander to view the logged signals.
5 Click the Format tab.
6 Click the Subplots button and select 3x1 to show three subplots.
7 For each signal:
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a Click the top subplot. A blue border indicates the plot selection.
b Select the check box next to the Alpha signal name. The signal data appears in the subplot.
c Plot the Pitch_rate signal in the middle subplot.
d Plot the Stick_input signal in the bottom subplot.

Proceed to “Run Executable and Load Data” on page 76-4.

Run Executable and Load Data
You must rebuild and run the myAircraftExample executable to obtain a valid data file because you
have modified the model.

1 In the Configuration Parameters dialog box, set the MAT-file variable name modifier
parameter to rt_. rt_ is prefixed to each variable that you selected for logging in the first part
of this example.

2 Click Apply and OK.
3 Save the model.
4 To generate code, on the C Code tab, click Build button.
5 When the build is finished, run the standalone program from the Command Window.

!myAircraftExample

The executing program writes the following messages to the Command Window.

** starting the model ** 
** created myAircraftExample.mat ** 

6 Load the data file myAircraftExample.mat.
load myAircraftExample
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Tip For UNIX platforms, run the executable program in the Command Window with the syntax !./
executable_name. If preferred, run the executable program from an OS shell with the syntax ./
executable_name. For more information, see “Run External Commands, Scripts, and Programs”.

Proceed to “Visualize and Compare Results” on page 76-5.

Visualize and Compare Results
When you follow the example sequence that began in “Configure Signal Data for Logging” on page
76-2, you obtain data from a Simulink run of the model and from a run of the program generated from
the model.

1 To view the execution output for alpha,rad, import the data into the Simulation Data Inspector.

a On the Simulation Data Inspector Visualize tab, click the Import button to open the Import
dialog.

b Specify Import from as Base workspace.
c Specify Import to as New run.
d To the left of Signal Name, click the check mark to clear the check boxes.
e Select the check box for the alpha,rad data where the Time Series Root is rt_yout.
f Click Import.

The selected data is now under Run 2: Imported_Data.
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2 View a plot of the executed data.

a Click the rt_yout expander.
b Click the top subplot and select the check box next to the alpha, rad signal name. The

signal data appears in the top subplot.

The alpha, rad signal from Run 1 and Run 2 overlap in the subplot because the signals are
equivalent.

It is possible to see a very small difference between simulation and code generation results. A slight
difference can be caused by many factors, including:

• Different compiler optimizations
• Statement ordering
• Run-time libraries

For example, a function call such as sin(2.0) can return a slightly different value depending on
which C library you use. Such variations can also cause differences between your results and these
results.

Compare States for Simulation and Code Generation
The order in which Simulink logs states during simulation is different than the order in which
Simulink Coder logs states during code generation. If you want to compare states between simulation
and code generation, sort the states by block name.

For example, by default, Simulink exports state data to the MATLAB variable, xout. Simulink Coder
exports state data to the variable rt_xout. To sort the state data for these variables, enter the
following commands in the MATLAB Command Window:

[~,idx1]=sort({xout.signals.blockName});
xout_sorted=[xout.signals(idx1).values];
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[~,idx2]=sort({rt_xout.signals.blockName}); 
rt_xout_sorted=[rt_xout.signals(idx2).values];

You can confirm that the logging order is the same between code generation and simulation by
entering the following command in the MATLAB Command Window:

isequal(xout_sorted, rt_xout_sorted)

See Also

Related Examples
• “Log Program Execution Results”
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Code Tracing in Embedded Coder

• “Verify Generated Code by Using Code Tracing” on page 77-2
• “Trace Simulink Model Elements in Generated Code” on page 77-8
• “Trace Stateflow Elements in Generated Code” on page 77-12
• “Link Generated Code to Requirements” on page 77-24
• “Reload Existing Traceability Information” on page 77-28
• “Customize Traceability Reports” on page 77-30
• “Trace Generated Code to Blocks” on page 77-33
• “Use Traceability in MATLAB Function Blocks” on page 77-35
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Verify Generated Code by Using Code Tracing
Code tracing (traceability) uses hyperlinks to navigate between a line of generated code and its
corresponding elements in a model. To find the lines of code and their corresponding elements, you
can also right-click an element or elements in a model. This two-way navigation is bidirectional
traceability.

Using code tracing, you can:

• Verify that generated code is as you expect. You can identify which model elements correspond to
a line of code. You can track code from different elements that you have or have not reviewed.

• Verify that generated code meets the design requirements. You can link requirements to the model
element and use code tracing to verify that the generated code for a model element meets the
assigned requirements.

When you generate code from a Simulink model, traceability information is embedded in the
generated code, unless explicitly unspecified. The traceability information includes links for tracing
between the generated source code and the model. You can view the generated code by either the:

• “Code View” on page 77-3: View the generated code in the Code view of the Code perspective.
• “Code Generation Report” on page 77-4: View the generated code as an HTML report in the

MATLAB web browser.

The generated code includes resources that support code tracing:

• Code element hyperlinks (indicated by underlining when you place your cursor over the code) to
trace variables or types in the generated code to their declarations or definitions in the header
files.

• Tags in code comments that identify elements in a model from which lines of code are generated.
• Line number hyperlinks that link to the model component from which the line of code was

generated.

Traceable Elements
Bidirectional traceability is supported for Simulink blocks and these Stateflow elements:

• States
• Transitions
• State transition tables
• MATLAB functions. Traceability is not supported for external code that you call from a MATLAB

function.
• Truth table blocks
• Graphical functions
• Simulink functions

Traceability in one direction is supported for these Stateflow elements:

• Events (code-to-model)
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Code-to-model traceability works for explicit events, but not implicit events. Clicking a hyperlink
for an explicit event in the generated code highlights that item in the Contents pane of the Model
Explorer.

• Junctions (model-to-code)

Model-to-code traceability works for junctions with at least one outgoing transition. Right-clicking
such a junction in the Stateflow Editor highlights the line of code that corresponds to the first
outgoing transition for that junction.

For more information, see “Trace Stateflow Elements in Generated Code” on page 77-12.

MATLAB Function blocks that you insert directly into a Simulink model are also traceable. For more
information, see “Use Traceability in MATLAB Function Blocks” on page 77-35.

Traceability in Generated Code
• “Code View” on page 77-3
• “Code Generation Report” on page 77-4

Code View

1 Open the model rtwdemo_comments.
2 Open the Embedded Coder app. Build the model. On the C Code tab, click Build.

The HTML code generation report opens by default. To use the report, see “Code Generation
Report” on page 77-4.

3 View the generated code in the Code view in the Code perspective.
4 Switch between the generated source files by using the drop-down list at the top of the Code

view.
5 The source code contains traceability information such as hyperlinked comments, line numbers,

variables, and operators. Place your cursor over or click a comment or line number hyperlink.
The Simulink Editor highlights the corresponding block or blocks in the model.
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6 To highlight the generated code for a block in the model, select the block. The generated code for
the block is highlighted in the Code view.

7 To open the generated code for a referenced model, open the referenced model and view the
generated code in the Code view.

Code Generation Report

1 Open the model rtwdemo_comments.
2 Open the Embedded Coder app. On the C Code tab, click Settings to open the Configuration

Parameters dialog box. Select Create code generation report if it is not already selected. By
default, Open report automatically, Code-to-model, and Model-to-code are selected.

3 If your model contains referenced models and you want to enable traceability for the referenced
model's code generation report, repeat the previous step for each referenced model.

4 Build the model. On the C Code tab, click Build. The build process opens the code generation
report in a MATLAB web browser.

5 In the left navigation pane, select a source code file. The source code and line numbers in the
right pane contain hyperlinks to blocks in the model.

6 Click a comment or line number hyperlink. The Simulink Editor displays and highlights the
corresponding block or blocks in the model.
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7 To highlight the generated code for a block in the model, right-click the block and select C/C++
Code > Navigate to C/C++ Code. The generated code for the block is then highlighted in the
HTML code generation report. To highlight the generated code for multiple blocks that you
select, hold the SHIFT key, select multiple blocks, and then right-click any one block to select
C/C++ Code > Navigate to C/C++ Code. The generated code for the blocks is then highlighted
in the HTML code generation report.

8 If you have a referenced model in your model, in the left navigation pane, under Reference
Models, click the link to a referenced model. The code generation report for the referenced
model is now displayed in the MATLAB web browser.

9 In the left navigation pane, you can click the Back button to go back to the previous code
generation report.

Traceability Tags
A traceability tag appears in a comment above the corresponding line of generated code. The format
of the tag is <system>/block_name.

• system is one of the following:
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• The text Root
• A unique system number assigned by the Simulink engine

• block_name is the name of the source block.

The code generator documents the tags for a model in the comments section of the generated header
file model.h. For example, this comment appears in the header file for a model, foo, that has a
subsystem Outer and a nested subsystem Inner:

/* Here is the system hierarchy for this model.
 *
 * <Root> : foo
 * <S1>   : foo/Outer
 * <S2>   : foo/Outer/Inner
 */

This code shows a tag comment above the generated line of code. A Gain block at the root level of a
source model generates this code:

/* Gain: '<Root>/UnDeadGain1' */
rtb_UnDeadGain1_h = dead_gain_U.In1 *  dead_gain_P.UnDeadGain1_Gain;

This code shows a tag comment above the generated line of code. A Gain block within a subsystem
one level below the root level of the source model generates this code:

/* Gain: '<S1>/Gain' */
dead_gain_B.temp0 *= (dead_gain_P.s1_Gain_Gain);

Operator Traceability
The generated code provides traceability between operators in the generated code and Simulink
blocks, Stateflow elements, or MATLAB Function blocks.

To verify the generated code by using operator traceability, in the generated code, click an operator
hyperlink to highlight the source block in the model.

These operators are supported.

Operator Type Operators
Arithmetic +, -, *, /, %

+=, -=, *=, /=, %=
++, -- (prefix and postfix)

Logical !, &&, ||
Relational ==, !=, <, >, <=, >=
Bit ~, |, ^, &, >>, <<

&=, ^=, |=, <<=, >>=
Conditional ?:

These operators are not supported.
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Operator Type Operator Examples
Assignment operator =
Member of and pointer operators Array subscript: a[b]

Address of and pointer dereference: &a, *a
Member of: a.b, a->b

Other operators Parenthesis in function call: foo(a,b)
Comma: a, b
Scope resolution: a::b
Cast: type(a)
new, new[]
delete, delete[]

Traceability Limitations
These limitations apply to reports generated by Embedded Coder software:

• Under the following conditions, model-to-code traceability is disabled for a block if the block name
contains:

• A single quote (').
• An asterisk (*) that causes a name-mangling ambiguity relative to other names in the model.

This name-mangling ambiguity occurs if in a block name or at the end of a block name, an
asterisk precedes or follows a slash (/).

• The character ÿ (char(255)).
• If a block name contains a newline character (\n), the generated code comment for the block path

hyperlink replaces the newline character with a space for readability.
• You cannot trace blocks representing these types of subsystems to generated code:

• Virtual subsystems
• Masked subsystems
• Nonvirtual subsystems for which code has been removed due to optimization

If you cannot trace a subsystem at subsystem level, you can trace individual blocks within the
subsystem.

• If you open a model on a platform that is different from the platform used to generate code, you
cannot use model-to-code and code-to-model traceability.

• Inline traceability is not available for files that are generated in shared_utils folder.

See Also

Related Examples
• “Trace Simulink Model Elements in Generated Code” on page 77-8
• “Trace Stateflow Elements in Generated Code” on page 77-12
• “Use Traceability in MATLAB Function Blocks” on page 77-35
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Trace Simulink Model Elements in Generated Code
To verify the generated code, Embedded Coder provides bidirectional traceability between the
Simulink model and the generated code. You can use either method for traceability:

• Code-to-model: The generated code displays these hyperlinks in comment lines in the generated
code:

• Block/subsystems names
• Line numbers
• Operators

To highlight the corresponding block or subsystem in the Simulink Editor, click the hyperlinks.
• Model-to-code: You can select single or multiple blocks of a model in the Simulink Editor and

navigate to the corresponding generated code.

Note The Code view in code perspective provides bidirectional traceability by default.

Code-to-Model Traceability
To use hyperlinks for tracing code-to-model elements:

1 Open the model and configure it as an ERT target.
2 Build or generate code for the model. The Code view opens by default to display the generated

code next to the model.
3 In the generated code, place your cursor over the block names in comments to highlight source

blocks. For example, generate an HTML report for the model rtwdemo_hyperlinks. In the
generated code for the model step function in rtwdemo_hyperlinks.c, place your cursor over
the UnitDelay: '<Root>/X' block. In the model window, the corresponding UnitDelay block
is highlighted.

77 Code Tracing in Embedded Coder

77-8

matlab:rtwdemo_hyperlinks


To use line numbers for tracing code-to-model elements:

1 In the previous model, rtwdemo_hyperlinks, click the hyperlink at line number 153. The line
numbers can differ from the numbers that appear in your generated code.

2 In the model window, the Chart subsystem is highlighted and contains the functionality on line
153.

Traceability to Hidden Blocks

The code generator sometimes inserts hidden blocks during the code generation process for various
reasons, for example, to maintain data integrity. Comments for the hidden blocks are included in the
generated code. These comments, and the code generated from the hidden block, trace back to the
original block in the model that triggered the insertion of the hidden block. Comments to hidden
blocks follow this template:
/* <Hidden_Block_Type> generated from: <Hyperlinked_Original_Block_Name> */
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For example,

/* SignalConversion generated from: '<Root>/Subsystem' */
  Varianttoground_B.VM_Conditional_Signal_Subsystem_0 = 0.0;

The hidden block SignalConversion is not present in the model. You can trace to the '<Root>/
Subsystem' block in the model that triggered the insertion of the hidden block by clicking on the
hyperlink on '<Root>/Subsystem'. For more information on this example, see “Code Generation
for Variant Blocks with One Variant Choice” on page 26-17.

Model-to-Code Traceability
To trace model elements to their corresponding generated code:

1 Complete steps 1 and 2 as in “Code-to-Model Traceability” on page 77-8
2 Build or generate code for the model. The generated code is displayed in the Code view window

next to the model.
3 In the model window, click on a model element. To select multiple blocks, hold the SHIFT key

and select additional blocks.
4 In the generated code in Code view window, you see the first instance of highlighted code that is

generated for the model element. At the top of the Code view, numbers that appear to the right of
generated file names indicate the total number of highlighted lines in each file. This figure shows
the result of tracing the Unit Delay block in model rtwdemo_hyperlinks.
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At the top of the code window, use the navigation bar to move forward and backward through
multiple instances of highlighted lines. Use the navigation sidebar to go directly to a line of code.

If you close and reopen a model, the Code view does not open until you open the Embedded Coder
app. The Code view might not be available because Embedded Coder cannot find a build folder for
your model in the current working folder. Reset the current working folder to the parent folder of the
existing build folder.

If you are using the code generation report and want to reload existing traceability information, see
“Reload Existing Traceability Information” on page 77-28.

See Also

Related Examples
• “Verify Generated Code by Using Code Tracing” on page 77-2
• “Trace Stateflow Elements in Generated Code” on page 77-12
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Trace Stateflow Elements in Generated Code
To verify the generated code for your Stateflow elements, you can trace Stateflow elements in your
model to the generated code by using these types of navigation:

• Code-to-model: Trace generated code back to the model by clicking hyperlinks in the comments or
the hyperlinked line numbers, which highlights the corresponding model element in the Simulink
Editor.

• Model-to-code: Trace the model elements in the Simulink Editor to corresponding lines in
generated code by right-clicking the model element and navigating to the generated code. This
traceability is not supported for some Stateflow elements in Code view.

These examples illustrate how to trace different Stateflow elements.

Inline Traceability for Stateflow Elements
Inline traceability refers to the line-level traceability available in the generated code. You can click
the hyper-linked line numbers to trace single or multiple Stateflow elements at the same time.

1 Open the model old_sf_car.
2 Configure the model as an ERT target.
3 On the Code Generation > Report pane, select these model configuration parameters:

• Create code generation report
• Open report automatically
• Code-to-model
• Model-to-code

4 Select Code Generation > Comments > Stateflow object comments configuration
parameter. This parameter enables the traceability comments for Stateflow elements.

5 Go to the Code Generation > Interface pane. In the Software environment section, select
continuous time. Click Apply. Before generating code, you must perform this step because this
model contains a block with a continuous sample time.

6 On the C Code tab, click Build.

After the code generation process is complete, the code generation report appears.
7 In the report, on the left navigation pane, click the old_sf_car.c hyperlink.
8 To the view the inline traceability hyperlinks, scroll through the code. These line numbers can

differ from the numbers that appear in your code generation report.
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9 Click the hyperlink on line number 190. The corresponding element is highlighted.

Bidirectional Traceability for States and Transitions
1 Open the model old_sf_car .
2 Complete steps 2 through 5 in “Inline Traceability for Stateflow Elements” on page 77-12.
3 Press Ctrl+B to generate source code and header files for the old_sf_car model that contains

the shift_logic chart. After the code generation process is complete, the code generation
report appears.

4 In the report, click the old_sf_car.c hyperlink.
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View Results

1 To see the traceability comments, scroll through the code. These line numbers can differ from the
numbers that appear in your code generation report.

2 Click the <S5>:2 hyperlink in this traceability comment:

/* During 'gear_state': '<S5>:2' */

The corresponding state appears highlighted in the chart.
3 Click the <S5>:12 hyperlink in this traceability comment:

/* Transition: '<S5>:12' */

The corresponding transition appears highlighted in the chart. To remove highlighting from an
element in the chart, press the Esc key.

4 You can also trace elements in the model to lines of generated code. In the chart, right-click the
element gear_state and select C/C++ Code > Navigate to C/C++ Code.

The code for that state appears highlighted in old_sf_car.c.

5 In the chart, right-click the transition with the condition [speed > up_th] and select C/C++
Code > Navigate to C/C++ Code.

The code for that transition appears highlighted in old_sf_car.c.
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Note For a list of the Stateflow elements in your model that are traceable, click the Traceability
Report hyperlink in the code generation report.

Bidirectional Traceability for State Transition Tables
This example shows how to navigate bidirectionally between elements in a state transition table and
the generated C/C++ and HDL code for traceability.

1 Open the model sf_cdplayer_STT. This model is already configured for traceability.
2 Press Ctrl+B to generate source code and header files for the sf_cdplayer_STT model. After

the code generation process is complete, the code generation report appears.
3 Click the sf_cdplayer_STT.c hyperlink in the report.
4 To see the traceability comments, scroll through the code. The line numbers shown can differ

from the numbers that appear in your code generation report.

5 Click the <S2>:58 hyperlink in this traceability comment:

/* Entry Internal 'ON': '<S2>:58' */

The corresponding state'ON' appears highlighted in the state transition table.
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6 You can trace a state or transition from the state transition table to the generated code. Right-
click the state Standby and select C/C++ Code > Navigate to C/C++ Code.

The entry code for the state Standby is highlighted in the generated code.
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Bidirectional Traceability for Truth Table Blocks
1 Open the model sf_climate_control.
2 Complete steps 2 through 5 in “Inline Traceability for Stateflow Elements” on page 77-12.
3 To build the model, press Ctrl+B.
4 In the code generation report, click the sf_climate_control.c hyperlink.
5 To see the traceability comments, scroll through the code. These line numbers can differ from the

numbers that appear in your code.

6 Click the <S1>:1:47 hyperlink in this traceability comment:

/* Action '3': '<S1>:1:47' */

In the Truth Table Editor, row 3 of the Action Table appears highlighted.
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7 You can also trace a condition, decision, or action in the table to a line of generated code. For
example, right-click a cell in the column D2 and select C/C++ Code > Navigate to C/C++
Code.

The code for that decision appears highlighted in sf_climate_control.c.

Tip To select C/C++ Code > Navigate to C/C++ Code for a condition, decision, or action,
right-click a cell in the row or column that corresponds to that truth table element.

77 Code Tracing in Embedded Coder

77-18



Bidirectional Traceability for Graphical Functions
1 Open the model sf_clutch_enabled_subsystems.
2 Complete steps 2 through 5 in “Inline Traceability for Stateflow Elements” on page 77-12.
3 In the Configuration Parameters dialog box, go to the Solver pane. In the Solver selection

section, select Fixed-step in the Type field. Click Apply. Before generating code, you must
perform this step because the model does not work with variable-step solvers.

4 To build the model, press Ctrl+B.
5 In the code generation report, click the sf_clutch_enabled_subsystems.c hyperlink.
6 To see the traceability comments, scroll through the code. These line numbers can differ from the

numbers that appear in your code generation report.

7 Click the <S1>:3 hyperlink in this traceability comment:

/* Graphical Function 'getSlipTorque': '<S1>:3' */

In the chart, the graphical function getSlipTorque appears highlighted.
8 You can trace a graphical function in the chart to a line of generated code. For example, right-

click the graphical function detectSlip and select C/C++ Code > Navigate to C/C++ Code.

The code for that graphical function appears highlighted in
sf_clutch_enabled_subsystems.c.

Code-to-Model Traceability for Events
1 Open the model sf_security.
2 Complete steps 2 through 5 in “Inline Traceability for Stateflow Elements” on page 77-12.
3 To build the model, press Ctrl+B.
4 In the code generation report, click the sf_security.c hyperlink.
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5 To see this traceability comment, scroll through the code. These numbers can differ from the
numbers that appear in your code generation report.

6 Click the <S3>:56 hyperlink in this traceability comment:

/* Event: '<S3>:56' */

In the Contents pane of the Model Explorer, the event Sound appears highlighted.

Model-to-Code Traceability for Junctions
1 Open the model ex_if_else_SF.
2 Complete steps 2 through 5 in “Inline Traceability for Stateflow Elements” on page 77-12.
3 To build the model, press Ctrl+B.
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4 In the code generation report, open the Stateflow chart named Chart.
5 Right-click the top-left junction and select C/C++ Code > Navigate to C/C++ Code.

The code for the first outgoing transition of that junction appears highlighted in
ex_if_else_SF.c.

Format of Traceability Comments for Stateflow Elements
The format of a traceability comment depends on the Stateflow element type.

State
Syntax

/* <ActionType> '<StateName>': '<elementHyperlink>' */

Example

/* During 'gear_state': '<S5>:2' */

This comment refers to the during action of the state gear_state, which has the hyperlink
<S5>:2.

Transition
Syntax

/* Transition: '<elementHyperlink>' */

Example

/* Transition: '<S5>:12' */

This comment refers to a transition, which has the hyperlink <S5>:12.

MATLAB Function
Syntax

/* MATLAB Function '<Name>': '<elementHyperlink>' */

Within the inlined code for a MATLAB function, comments that link to individual lines of the function
have this syntax:

/* '<elementHyperlink>' */

Examples

/* MATLAB Function 'test_function': '<S50>:99' */

/* '<S50>:99:20' */

The first comment refers to the MATLAB function named test_function, which has the hyperlink
<S50>:99.
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The second comment refers to line 20 of the MATLAB function in your chart.

Truth Table Block
Syntax

/* Truth Table Function '<Name>': '<elementHyperlink>' */

Within the inlined code for a Truth Table block, comments for conditions, decisions, and actions have
this syntax:

/* Condition '#<Num>': '<elementHyperlink>' */
/* Decision 'D<Num>': '<elementHyperlink>' */
/* Action '<Num>': '<elementHyperlink>' */

<Num> is the row or column number that appears in the Truth Table Editor.

Examples

/* Truth Table Function 'truth_table_default': '<S10>:100' */

/* Condition '#1': '<S10>:100:8' */
/* Decision 'D1': '<S10>:100:16' */
/* Action '1': '<S10>:100:31' */

The first comment refers to a Truth Table block named truth_table_default, which has the
hyperlink <S10>:100.

The other three comments refer to elements of that Truth Table block. Each condition, decision, and
action in the Truth Table block has a unique hyperlink.

Truth Table Function

For syntax and examples, see “Truth Table Block” on page 77-22.

Graphical Function
Syntax

/* Graphical Function '<Name>': '<elementHyperlink>' */

Example

/* Graphical Function 'hello': '<S1>:123' */

This comment refers to a graphical function named hello, which has the hyperlink <S1>:123.

Simulink Function
Syntax

/* Simulink Function '<Name>': '<elementHyperlink>' */

Example

/* Simulink Function 'simfcn': '<S4>:10' */

This comment refers to a Simulink function named simfcn, which has the hyperlink <S4>:10.
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Event
Syntax

/* Event: '<elementHyperlink>' */

Example

/* Event: '<S3>:33' */

This comment refers to an event, which has the hyperlink <S3>:33.

See Also

Related Examples
• “Verify Generated Code by Using Code Tracing” on page 77-2
• “Trace Simulink Model Elements in Generated Code” on page 77-8
• “Trace Data, Events, and Messages” (Stateflow)
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Link Generated Code to Requirements
Link generated code to model element requirements. Using configuration parameters, you can
specify whether to include requirement descriptions as comments in the generated code.

Open Model

Open the rtwdemo_requirements model. The model contains Simulink® and Stateflow® elements
with associated requirements.

model='rtwdemo_requirements';
open_system(model);

View Requirements

You can view requirements linked to the model by using the Requirements Editor. In the Simulink
Editor, open the Requirements Manager app. On the Requirements tab, click Requirements
Editor. You can view requirements specific to model objects by using the object context menu. Right-
click an element and select Requirements > Open Outgoing Links dialog. To view the
requirements, use these commands:

1. To view the requirements for the DiscretePulseGenerator block, right-click the
DiscretePulseGenerator block and select Requirements > Open Outgoing Links dialog to
open Outgoing Links Editor. Using Outgoing Links Editor, you can create, edit, and delete
requirements traceability links.

clockblock='rtwdemo_requirements/clock';
clockblockh=get_param(clockblock,'handle');
rmi('edit',clockblockh);
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2. To view the requirements, open the Signal Builder block by double-clicking it.

sigbblock='rtwdemo_requirements/Signal Builder';
open_system(sigbblock)

3. To view the requirements for the Stateflow® state, open the Outgoing Links Editor.

state=find(sfroot,'-isa','Stateflow.State','-and','Tag','req_state');
rmi('edit',state.id);

4. To view the requirements for the Stateflow transition, open the Outgoing Links Editor.

trans=find(sfroot,'-isa','Stateflow.Transition','-and','Tag','req_trans');
rmi('edit',trans.id);

5. To view the requirements for the Stateflow function, open the Outgoing Links Editor.

func=find(sfroot,'-isa','Stateflow.Function','-and','Tag','req_function');
rmi('edit',func.id);

Close the open windows.
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close_system(sigbblock);

Set Configuration Parameters

Open the Configuration Parameters dialog box Code Generation > Comments pane. View the
configuration parameter settings.

model = bdroot;
configSet = getActiveConfigSet(model);
openDialog(configSet);

Generate Code

Generate code for the model.

slbuild('rtwdemo_requirements')

### Starting build procedure for: rtwdemo_requirements
### Successful completion of build procedure for: rtwdemo_requirements

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
rtwdemo_requirements  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 19.342s

In the generated code, view the comments containing the requirements. To view all the requirements,
click the hyperlinked requirement comment.

rtwdemodbtype('rtwdemo_requirements_ert_rtw/rtwdemo_requirements.c',...
    '/* Function for Chart:','return result;',1,0);

/* Function for Chart: '<Root>/rebound_elimination' */
static real_T rebound_fcn(real_T prev_in, real_T prev_out, real_T curr_in)
{
  real_T result;

  /* Graphical Function 'rebound_fcn': '<S2>:2':
   *  1. Result Computation
   */
  /* Transition: '<S2>:4' */
  if (prev_in == curr_in) {
    /* Transition: '<S2>:5' */
    result = curr_in;
  } else {
    /* Transition: '<S2>:6' */
    /* Transition: '<S2>:7' */
    result = prev_out;
  }

77 Code Tracing in Embedded Coder

77-26



Close Model

rtwdemoclean;
close_system('rtwdemo_requirements',0);

See Also

Related Examples
• “Link Blocks and Requirements” (Simulink Requirements)
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Reload Existing Traceability Information
When you build a model, the traceability information is stored in the build folder. The format of the
build folder for an ERT-based target is model_ert_rtw.

Model-to-code parameter should be selected in the original build to be able to reload the
traceability information in a new Simulink session. To reload existing traceability information for a
model:

1 Reset the current working folder to the parent folder of the existing build folder.
2 In the Configuration Parameters dialog box, next to Model-to-code, click Configure.
3 In the Model-to-code navigation dialog box, in the Build folder field, type or browse to the build

folder that contains the existing traceability information.

If you close and reopen a model, the Navigate to Code context menu option might not be available
because Embedded Coder cannot find a build folder for your model in the current working folder. In
that case, perform these steps:

1 To open the Model-to-code navigation dialog box, click Configure.
2 In the Model-to-code navigation dialog box, click Browse.
3 Browse to the build folder for your model and select the folder. The build folder path is displayed

in the Build folder field.

4 If you selected Model-to-code for the build, clicking Apply or OK loads traceability information
from the earlier build into your Simulink session.

5 To open the context menu and trace a model element to corresponding code, right-click a model
element and select C/C++ Code > Navigate to C/C++ Code.
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See Also

Related Examples
• “Open Code Generation Report” on page 52-7
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Customize Traceability Reports
Even a relatively small model can generate hundreds of lines of C/C++ code. To help you navigate
more easily between the generated code and your source model, Embedded Coder provides the
traceability report section. When you enable traceability, Embedded Coder display the generated
code in Code view or code generation report. You can generate reports in the Configuration
Parameters dialog box or at the command line.

In the Configuration Parameters dialog box, the Code Generation > Report pane lists parameters
that you can select and clear to customize the content of your traceability reports.

Select or clear any combination of these parameters. These parameters are on by default.

• Eliminated / virtual blocks (account for blocks that are untraceable)
• Traceable Simulink blocks
• Traceable Stateflow elements
• Traceable MATLAB functions

If you select all parameters, you get a complete mapping between model elements and the generated
code.

This figure shows the top section of the traceability report, which is generated when you select all
traceability content parameters for model rtwdemo_hyperlinks.
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Generate a Traceability Matrix
The traceability matrix provides traceability among model elements, generated code, and model
requirements in a Microsoft Excel® file format.

If you have DO Qualification Kit software or IEC Certification Kit software and are using a Windows
host, you can generate a traceability matrix into Microsoft Excel format directly from the traceability
report.
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Go to the Traceability Report section of the HTML code generation report and click Generate
Traceability Matrix.

To select an existing matrix file to update or specify a matrix file to create, use the options in the
Generate Traceability Matrix dialog box. Optionally, you can select and create an order to the
columns that appear in the generated matrix. After specifying the location where you want the matrix
file, click the Generate button.

For more information, see "Generating a Traceability Matrix" in either the DO Qualification Kit
documentation (DO Qualification Kit) or the IEC Certification Kit documentation (IEC Certification
Kit).

See Also

Related Examples
• “Reports for Code Generation” on page 52-2
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Trace Generated Code to Blocks
Navigate and trace between generated code and its source model for verification.

Open Example Model

Open the example model rtwdemo_hyperlinks.

model='rtwdemo_hyperlinks';
open_system(model)

Code to Model Navigation

Navigate from the generated code to the model.

1 In the Configuration Parameters dialog box, open the Code Generation > Report pane.
2 Verify that the following parameters are selected: Create code generation report, Open

report automatically and Code-to-model.
3 In the model editor window, press Ctrl+B to generate code. After the code generation process is

complete, the code generation report appears.
4 In the generated report, click the rtwdemo_hyperlinks.c link to see the code with embedded

hyperlinks.
5 Click links in the code to trace generated code segments to the highlighted elements in the

model. For example, if you click the hyperlink <Root>/Sum, the Sum block in the model is
highlighted.

Model to Code Navigation

Navigate from the model to the generated code.

1 In the Configuration Parameters dialog box, open the Code Generation > Report pane.
2 Verify that the following parameters are selected: Create code generation report, Open

report automatically and Model-to-code.
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3 In the model editor window, press Ctrl+B to generate code. After the code generation process is
complete, the code generation report appears.

4 In the model window, right-click any block and select C/C++ Code > Navigate To C/C++ Code.
The software highlights the generated code for this block in the code generation report.

5 Inspect the highlighted lines in the code generation report. The total number of highlighted lines
is displayed next to each source file name in the left pane of the report. Use the Previous and
Next buttons to navigate through the highlighted lines.

Note: Model-to-code navigation also works for Stateflow objects and MATLAB functions.

Note: The report displays a diagnostic message if there is no code to highlight for the selected block
(for example, if you select a virtual block).

Traceability Report

Generate and inspect the Traceability Report.

1 In the Configuration Parameters dialog box, open the Code Generation > Report pane.
2 Verify that the following parameters are selected: Create code generation report, Open

report automatically
3 Search for the traceability report parameters using keyword GenerateTraceReport. Verify all

the listed parameters are selected.
4 In the model editor window, press Ctrl+B to generate code. After the code generation process is

complete, the code generation report appears.
5 To see a report of the untraceable (not in the generated code) and traceable blocks in your

model, on the left pane of the generated report click Traceability Report.
6 In the Traceability Report, inspect the Eliminated / Virtual Blocks and Traceable Blocks

lists. For example, the Scope block is an untraceable block. It is listed under Eliminated /
Virtual Blocks because the code generator does not generate code for this block.

See Also

External Websites
• “Verify Generated Code by Using Code Tracing” on page 77-2
• “Trace Simulink Model Elements in Generated Code” on page 77-8
• “Trace Stateflow Elements in Generated Code” on page 77-12
• “Use Traceability in MATLAB Function Blocks” on page 77-35
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Use Traceability in MATLAB Function Blocks
Extent of Traceability in MATLAB Function Blocks
Like other Simulink blocks, MATLAB Function blocks support bidirectional traceability, but extend
navigation to lines of source code. That is, you can navigate between a line of generated code and its
corresponding line of source code. In other Simulink blocks, you can navigate between a line of
generated code and its corresponding object.

In addition, you can select to include the source code as comments in the generated code. When you
select MATLAB source code as comments parameter, the MATLAB source code appears
immediately after the associated traceability tag. For more information, see “Include MATLAB Code
as Comments in Generated Code” on page 46-23.

For information about how traceability works in Simulink blocks, see “Verify Generated Code by
Using Code Tracing” on page 77-2.

Traceability Requirements
To enable traceability comments in your code, you must have a license for Embedded Coder software.
These comments appear only in code that you generate for an Embedded Real-Time (ERT) target.

Note Traceability is not supported for MATLAB files that you call from a MATLAB Function block.

Using Traceability in a MATLAB Function Block
This example shows how to trace between source code and generated code in a MATLAB Function
block in the rtwdemo_dynamicio model. Follow these steps:

1 Open model rtwdemo_dynamicio.
2 Open the Embedded Coder app.
3 Change the system target file to ert.tlc when prompted. Traceability comments appear

hyperlinked in generated code only for embedded real-time (ert.tlc) targets.
4 In the Configuration Parameters dialog box, on the Code Generation > Report pane, select

these parameters, if not already selected:

• Create code generation report
• Open report automatically
• Code-to-model
• Model-to-code

5 In the Code Generation > Comments pane, select the MATLAB source code as comments
and Stateflow object comments parameters. These parameters control different parts of the
traceability comment.

6 In the model window, press Ctrl+B.

This action generates source code and header files for the rtwdemo_dynamicio model that
contains the emlHorizontalSum and emlVerticalSum blocks. After the code generation
process is complete, the code generation report appears automatically.
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7 Click the rtwdemo_dynamicio.c hyperlink in the report.
8 Scroll down through the code to see the traceability comments, which appear as links inside /

*...*/ brackets, as in this example.

9 Click the <S1>:1:2 hyperlink in this traceability comment:

/* '<S1>:1:2' y = sum(u,2); */

Line 2 of the function in the source code appears highlighted in the MATLAB Function Block
Editor.

10 You can trace a line in a MATLAB function to lines of generated code. For example, right-click on
line 2 of your function and select Code Generation > Navigate to Code from the context menu.

The code location for line 2 appears highlighted in rtwdemo_dynamicio.c.
11 You can trace a line of generated code to a line of source code in a MATLAB function using the

line number hyperlinks in the generated code.

See Also

More About
• “Verify Generated Code by Using Code Tracing” on page 77-2
• “Include MATLAB Code as Comments in the Generated Code” on page 46-23
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Component Verification in Target Environment
After you generate production code for a component design, you need to integrate, compile, link, and
deploy the code as a complete application on the embedded system. One approach is to manually
integrate the code into an existing software framework that consists of an operating system, device
drivers, and support utilities. The algorithm can include externally written legacy or custom code.

An easier approach to verifying a component in a target environment is to use processor-in-the-loop
(PIL) simulation. For information about PIL simulations, see “SIL and PIL Simulations” on page 80-
2.

Goals of Component Verification
Assuming that you have generated production source code and integrated required externally written
code, such as drivers and a scheduler, you can verify that the integrated software operates as
expected by testing it in the target environment. During testing, you can achieve either of the
following goals, depending on whether you export code that is strictly ANSI C/C++ or mixes ANSI
C/C++ with code optimized for a target environment.

Goal Type of Code Export
Maximize code portability and configurability ANSI C/C++
Simplify integration and maximize use of processor resources
and code efficiency

Mixed code

Regardless of your goal, you must integrate required external drivers and scheduling software. To
achieve real-time execution, you must integrate the real-time scheduling software.

To maximize code portability and configurability, limit the application code to ANSI/ISO C or C++
code only, as the following figure shows.
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To simplify code integration and maximize code efficiency for a target environment, use Embedded
Coder features for:

• Controlling code interfaces
• Exporting subsystems
• Including target-specific code, including compiler optimizations

The following figure shows a mix of ANSI C/C++ code with code that is optimized for a target
environment.
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Run Component Tests
The workflow for running software component tests in the target environment is:

1 Integrate external code, for example, for device drivers and a scheduler, with the generated C or
C++ code for your component model. For more information, see “S-Functions and Code
Generation”. For more specific references that depend on your verification goals, see the
following table.

For See
ANSI C/C++ code integration “Integrate C Functions Using Legacy Code Tool”. Also,

open rtwdemos and navigate to the Custom Code
folder.
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For See
Mixed code integration • “Generate Component Source Code for Export to

External Code Base” on page 56-47 and example
rtwdemo_exporting_functions

• “Configure C Code Generation for Model Entry-
Point Functions” on page 33-112, “Interactively
Configure C++ Interface” on page 42-2, and
example rtwdemo_fcnprotoctrl

• “What Is Code Replacement?” on page 55-2, “What
Is Code Replacement Customization?” on page 67-3,
and example rtwdemo_crl_script

2 Simulate the integrated component model.
3 Generate code for the integrated component model.
4 Connect to data interfaces for the generated C code data structures. See “Exchange Data

Between Generated and External Code Using C API” and “Export ASAP2 File for Data
Measurement and Calibration”. Also see examples rtwdemo_capi and rtwdemo_asap2.

5 Customize and control the build process, if required. See “Customize Post-Code-Generation Build
Processing”, and example rtwdemo_buildinfo .

6 Create a zip file that contains generated code files, static files, and dependent data to build the
generated code in an environment other than your host computer. See “Relocate Code to Another
Development Environment”, and example rtwdemo_buildinfo.
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Real-Time Software Component Verification
One approach to verifying a software component is to build the component into a complete software
system that can execute in real time in the target environment. A complete software system includes:

• Algorithm for the software component
• Scheduling algorithms
• Calls to drivers for board-specific devices

This single build approach is more time consuming to set up, but makes it easier to get the complete
application running in the target environment.

The following figure shows code generated for an algorithm being built into a complete system
executable for the target environment.

The workflow for testing component software as part of a complete real-time target environment is:

1 Develop a component model and generate source code for production.

For information on building in scheduling and real-time system support, see:

• “Time-Based Scheduling and Code Generation” and “Modeling for Multitasking Execution”.
For an example, open rtwdemos and navigate to the Multirate Support folder.
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• “Asynchronous Events” and example rtwdemo_async
• “Deploy Generated Standalone Executable Programs To Target Hardware” on page 66-2
• “Workflows for AUTOSAR” (AUTOSAR Blockset) and example “Develop a Model that Complies

with the AUTOSAR Standard” on page 23-18.
2 Optimize generated code for a specific run-time environment, using specialized function libraries.

For more information, see “What Is Code Replacement?” on page 55-2, “What Is Code
Replacement Customization?” on page 67-3, and “Optimize Generated Code By Developing and
Using Code Replacement Libraries - Simulink®” on page 72-27.

3 Customize post code generation build processing to accommodate third-party tools and
processes, as required. See “Customize Post-Code-Generation Build Processing” and example
rtwdemo_buildinfo.

4 Integrate external code, for example, for device drivers and a scheduler, with the generated C or
C++ code for your component model. For more information, see “S-Functions and Code
Generation”. For more specific references depending on your verification goals, see the following
table.

For... See...
ANSI C/C++ code integration “Integrate C Functions Using Legacy Code Tool”. Also,

open rtwdemos and navigate to the Custom Code
folder.

Mixed code integration • “Generate Component Source Code for Export to
External Code Base” on page 56-47 and example
rtwdemo_exporting_functions

• “Configure C Code Generation for Model Entry-
Point Functions” on page 33-112, “Interactively
Configure C++ Interface” on page 42-2, and
example rtwdemo_fcnprotoctrl

• “What Is Code Replacement?” on page 55-2, “What
Is Code Replacement Customization?” on page 67-3,
and example “Optimize Generated Code By
Developing and Using Code Replacement Libraries -
Simulink®” on page 72-27

5 Simulate the integrated model.
6 Generate code for the integrated model.
7 Connect to data interfaces for the generated C code data structures. See “Exchange Data

Between Generated and External Code Using C API” and “Export ASAP2 File for Data
Measurement and Calibration”. Also see examples rtwdemo_capi and rtwdemo_asap2.

8 Customize and control the build process, as required. See “Customize Post-Code-Generation
Build Processing”, and example rtwdemo_buildinfo .

9 Create a zip file that contains generated code files, static files, and dependent data to build the
generated code in an environment other than your host computer. See “Relocate Code to Another
Development Environment”, and example rtwdemo_buildinfo.
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Numerical Equivalence Checking in
Embedded Coder

• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
• “Configure and Run SIL Simulation” on page 80-15
• “Configure and Run PIL Simulation” on page 80-26
• “Simulation Mode Override Behavior in Model Reference Hierarchy” on page 80-35
• “Debug Generated Code During SIL Simulation” on page 80-37
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Host-Target Communication for Simulink PIL simulation” on page 80-43
• “Specify Hardware Timer” on page 80-46
• “Set Up PIL Connectivity by Using target Package” on page 80-49
• “Custom Toolchain Directives Required for Code Coverage and Execution Profiling”

on page 80-59
• “PIL Simulation Sequence” on page 80-60
• “Verification of Code Generation Assumptions” on page 80-62
• “View SIL and PIL Files in Code Generation Report” on page 80-65
• “SIL/PIL Manager Verification Workflow” on page 80-67
• “Security for PIL Simulations” on page 80-73
• “SIL and PIL Limitations” on page 80-74
• “Test Generated Code with SIL and PIL Simulations” on page 80-85
• “Create a Target Communication Channel for Processor-In-The-Loop (PIL) Simulation”

on page 80-99
• “Configure Processor-In-The-Loop (PIL) for a Custom Target” on page 80-104
• “Field-Oriented Control of Permanent Magnet Synchronous Machine” on page 80-109
• “Check Configuration” on page 80-126
• “Verify Numerical Equivalence with CGV” on page 80-127
• “Verify Numerical Equivalence Between Two Modes of Execution of a Model” on page 80-128
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SIL and PIL Simulations

In this section...
“What Are SIL and PIL Simulations?” on page 80-2
“Why Use SIL and PIL” on page 80-2
“How SIL and PIL Simulations Work” on page 80-3
“Comparison of SIL and PIL Simulations” on page 80-4
“Code Interfaces for SIL and PIL” on page 80-5
“Scheduling Considerations” on page 80-6
“Imported Data and Function Definitions” on page 80-7

What Are SIL and PIL Simulations?
With Embedded Coder, you can run software-in-the-loop (SIL) and processor-in-the-loop (PIL)
simulations of your model. These simulations generate source code for either the top model or part of
the model. A SIL simulation compiles and runs the generated code on your development computer. A
PIL simulation cross-compiles source code on your development computer, and then downloads and
runs the object code on a target processor or an equivalent instruction set simulator.

With SIL and PIL simulations, you can:

• Test whether your model and generated code are numerically equivalent.
• Observe code coverage.
• Perform code execution profiling.

Why Use SIL and PIL
Through SIL and PIL, you can early on test and fix defects. For example, you can model and test a
system component in normal mode. Then, you can reuse your test suites in a SIL or PIL simulation
that runs compiled generated code. To check numerical equivalence, you compare normal and SIL or
PIL simulation results. You do not have to leave the Simulink environment to test generated code on a
separate infrastructure.

This table describes situations where you can use SIL and PIL.

Situation Use
Test numerical equivalence between model and generated code by reusing
test vectors developed for normal mode simulation to verify numerical output
of generated (or legacy) code. See “SIL/PIL Manager Verification Workflow”
on page 80-67 and “Test Two Simulations for Equivalence” (Simulink Test)

SIL and PIL

Collect metrics for generated code:

• Code coverage. See “Code Coverage”.
• Execution profiling. See “Code Execution Profiling with SIL and PIL” on

page 74-2

SIL and PIL
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Situation Use
(Requires an IEC Certification Kit license.)

Perform verification and validation activities on the generated C/C++ code in
accordance to the requirements of the overall software safety lifecycle as
defined by the ISO 26262-6, IEC 61508-3, IEC 62304, EN 50128, and EN
50657 functional safety standards. For detailed information about the SIL
and PIL verification activities in the IEC Certification Kit Model-Based Design
workflow, see the Reference Workflow for Embedded C/C++ Applications
(certkitiec_ecoder_workflow.docx/pdf) artifact in the Artifacts
Explorer (IEC Certification Kit).

SIL and PIL

(Requires a DO Qualification Kit license.)

Test the output of the integration process to satisfy relevant objectives in the
DO-178C and DO-333 safety standards. For additional information, see
Testing of Outputs of Integration Process (DO Qualification Kit). This
information is available also in the Model-Based Design Workflow for
DO-178C (qualkitdo_do178_workflow.pdf) artifact in the Artifacts
Explorer (DO Qualification Kit).

SIL and PIL

Without target hardware, get a convenient alternative to PIL. SIL
With target hardware, for example, an evaluation board or instruction set
simulator:

• Verify behavior of target-specific code, for example, code replacement
optimizations, and legacy code. See “What Is Code Replacement?” on
page 55-2 and “What Is Code Replacement Customization?” on page 67-3.

• Optimize the execution speed and memory footprint of your code. In this
table, see the information about collecting execution profiling and stack
profiling metrics.

• Investigate effects of compiler settings and optimizations, for example,
deviation from ANSI C overflow behavior.

Normal simulation techniques do not account for restrictions and
requirements that the hardware imposes, such as limited memory resources
or behavior of target-specific optimized code.

For information about running PIL simulations on specific targets, see
“Sample Custom Targets” in the Simulink Coder documentation.

PIL

Note The SIL and PIL simulation modes are not designed for the reduction of model simulation
times. If you want to speed up the simulation of your model, use the rapid accelerator mode. For
more information, see “What Is Acceleration?”.

How SIL and PIL Simulations Work
In a SIL or PIL simulation, code is generated for either the top model or part of the model. With SIL,
this code is compiled for and executed on your development computer. With PIL, the code is cross-
compiled for the target hardware and runs on the target processor.
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Through a communication channel, Simulink sends stimulus signals to the code on your computer or
target processor for each sample interval of the simulation.

• For a top model, Simulink uses stimulus signals from the base or model workspace.
• If you have designated only part of the model to simulate in SIL or PIL mode, then a part of the

model remains in Simulink and code is not generated for this part of the model. Typically, you
configure this part of the model to provide test vectors for the software executing on the
hardware. This part of the model can represent other parts of the algorithm or the environment in
which the algorithm operates.

When your computer or target processor receives signals from Simulink, the processor executes the
SIL or PIL algorithm for one sample step. The SIL or PIL algorithm returns output signals calculated
during this step to Simulink through a communication channel. One sample cycle of the simulation is
complete, and Simulink proceeds to the next sample interval. The process keeps repeating itself and
the simulation progresses. SIL and PIL simulations do not run in real time. In each sample period,
Simulink and the object code exchange I/O data.

Comparison of SIL and PIL Simulations
Type of SIL or PIL
Simulation

What Happens in SIL Simulation What Happens in PIL Simulation

Specify through:

• Top-model simulation
mode

• Model block
Simulation mode
parameter

• Test behavior of generated
source code on development
computer. Simulation does not
test code compiled for target
hardware because code is
compiled for the development
computer (different compiler and
different processor architecture
than the target).

• Generated production code
compiled and executed on
development computer as
separate process, independent of
MATLAB process.

• Execution is host/host and
nonreal time.

• Test object code that you intend
to deploy in production on
either real target hardware or
an instruction set simulator.

• On development computer,
generated production code
cross-compiled for target.
Object code downloaded and
executed on target processor or
instruction set simulator.

• Execution is host/target and
nonreal time.

Use SIL or PIL block
created from subsystem.

• Simulation runs compiled object
code through S-function. S-
function communicates with
object code executing as
standalone application on
development computer. SIL block
execution is independent of the
MATLAB process.

• Execution is host/host and
nonreal time.

• Simulation runs cross-compiled
object code through S-function
on development computer. S-
function communicates with
object code executing as
standalone application on target
processor or instruction set
simulator.

• Execution is host/target and
nonreal time.
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Code Interfaces for SIL and PIL
You generate standalone code when you perform, for example, a top-model or right-click subsystem
build for a single deployable component. You can compile and link standalone code into a standalone
executable or integrate it with other code. For more information on the standalone code interface,
see “Configure C Code Generation for Model Entry-Point Functions”.

When you generate code for a referenced model hierarchy, the software generates standalone
executable code for the top model and a library module called a model reference target for each
referenced model. When the code executes, the standalone executable invokes the applicable model
reference targets to compute the referenced model outputs. For more information, see “Build Model
Reference Targets”.

To integrate generated code with legacy code, use standalone code because the standalone code
interface is documented.

Note SIL and PIL simulations do not provide direct support for custom code interfaces. You can
incorporate these interfaces into Simulink as an S-function, for example, using the Legacy Code Tool,
S-Function Builder, or handwritten code. Then, you can verify the custom code by using SIL and PIL
simulations.

This table provides the interfaces that SIL and PIL simulations generate.

SIL/PIL
Simulation

Code Interface

Top-model SIL/PIL simulation generates the standalone code interface. If code exists,
simulation calls standalone code for the model . If code does not exist, simulation
generates standalone code.

Model block If you set Code interface block parameter to Top model, SIL/PIL simulation
generates standalone code interface. Simulation calls standalone code for the
model if it exists. Otherwise, simulation generates standalone code by using
slbuild('model') command.

If you set Code interface block parameter to Model reference, SIL/PIL
simulation generates model reference code interface. Simulation calls model
reference target for Model block if it exists. Otherwise, simulation generates model
reference target by using slbuild('model',
'ModelReferenceCoderTargetOnly') command.

SIL or PIL block Block uses standalone code interface.
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Scheduling Considerations
Item Information
Algebraic loops There are algebraic loops that occur in SIL and PIL simulations but not in normal

mode simulations:

• Single output/update function in code generation optimization can introduce
algebraic loops because the option introduces direct feedthrough via a combined
output and update function.

Single output/update function is not compatible with Minimize algebraic
loop occurrences (in the Subsystem Parameters dialog box and Configuration
Parameters > Model Referencing pane). Minimize algebraic loop
occurrences allows code generation to remove algebraic loops by partitioning
generated code between output and update functions to avoid direct
feedthrough.

• If you generate code for a virtual subsystem, code generation treats the
subsystem as atomic and generates the code accordingly. The resulting code can
change the execution behavior of your model, for example, by applying algebraic
loops, and introduce inconsistencies to the simulation behavior.

To enable consistent simulation and execution behavior for your model, declare
virtual subsystems as atomic subsystems.

For more information, see:

• “Algebraic Loop Concepts”
• “Algebraic Loops”
• “Control Generation of Functions for Subsystems”

Exported
functions in
feedback loops

If your model has function-call subsystems and you export a subsystem that has
context-dependent inputs (for example, feedback signals), the results of a SIL/PIL
simulation with the generated code and the results of the normal mode simulation of
your model can differ. One approach to make SIL/PIL and normal mode simulations
yield identical results is to use Function-Call Feedback Latch blocks in your model.
You can make context-dependent inputs become context-independent.

Embedded Coder generates a warning identifying context-dependent inputs of
exported function-call subsystems if you set the Context-dependent
inputsconfiguration parameter to one of the following:

• Enable all as warnings
• Use local settings
• Disable all

For more information, see:

• “Control Generation of Functions for Subsystems”
• Function-Call Feedback Latch
• “Context-dependent inputs”
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Imported Data and Function Definitions
• “Imported Data” on page 80-7
• “GetSet Custom Storage Class” on page 80-7
• “Custom Storage Class of Type Other” on page 80-7
• “AUTOSAR Runtime Environment” on page 80-9

Imported Data

In SIL and PIL simulations, you can use signals, parameters, and data stores that specify storage
classes with imported data definitions. The simulations define storage for imported data associated
with:

• Signals at the root level of the component (on the I/O boundary).
• Parameters in the base workspace or a data dictionary. For parameters in the model workspace:

• Top-model SIL/PIL and SIL/PIL block simulations define storage.
• Model block SIL/PIL simulations do not define storage. You must define storage and specify

initial values that match MATLAB values.
• Global data stores.

SIL and PIL simulations do not define storage for other imported data. For example, the simulations
do not define storage for imported data associated with:

• Internal signals (not on the I/O boundary)
• Local data stores

In these cases, define the storage through custom code included by the component under test or
through the PIL rtw.pil.RtIOStreamApplicationFramework API.

See also “Tunable Parameters and SIL/PIL” on page 80-74.

GetSet Custom Storage Class

SIL and PIL simulations support the GetSet custom storage class. The SIL/PIL test harness provides
C definitions of the Get and Set functions that are used during simulations. For more information,
see “Access Data Through Functions with Storage Class GetSet” on page 38-26.

Custom Storage Class of Type Other

To enable SIL and PIL support for the custom storage class where Type is set to Other , create a
custom attributes class for the custom storage class and associate the custom attributes class with a
Boolean property, SupportSILPIL, set to true.

classdef CSCOtherAttributes < Simulink.CustomStorageClassAttributes
  properties(PropertyType = 'logical scalar')
    SupportSILPIL = true;
  end
end

For more information about custom attributes, see “Further Customize Generated Code by Writing
TLC Code” on page 38-23 and “Finely Control Data Representation by Writing TLC Code for a
Storage Class” on page 38-24.
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To build the SIL or PIL application interface, the code generator calls the DataAccess and
ClassAccess functions in the associated custom TLC file to get required information. The code
generator stores the extracted information in build artifacts in the build folder.

For a custom storage class that is not grouped:

• The code generator calls DataAccess with the request argument taking values of define,
declare, layout, contents, address, or set.

• The code generator uses the string returned by DataAccess(record, "define", "", "") to
define the variable in the SIL or PIL application if one of these is true:

• The signal or parameter has an Imported data scope.
• The model uses a model reference code interface.
• The model uses a top model code interface, EnableDataOwnership is on, and the Owner

attribute for the custom storage class is not empty and not equal to the name of the current
model

• The code generator uses the string returned by DataAccess(record, "declare", "", "")
to declare the variable in the SIL or PIL application if the following are true:

• The model uses a top model code interface.
• The signal or parameter uses an Exported storage class.
• EnableDataOwnership is off, or EnableDataOwnership is on and the Owner attribute for

the custom storage class is empty or equal to the model name.
• Code packaging is configured so that the variable is not declared in model.h or a header file

that is included by model.h

For a custom storage class that is grouped:

• The code generator calls DataAccess with the request argument taking values of layout,
address, or set.

• The code generator calls ClassAccess with the request argument taking the value of
groupTypeDeclDefn.

• You must provide the grouped type (struct) definition and the extern declaration of the
grouped variable if one of these is true:

• The signal or parameter has an Imported data scope.
• The model uses a model reference code interface.
• The model uses a top model code interface, EnableDataOwnership is on, and the Owner

attribute for the custom storage class is not empty and not equal to the name of the current
model

Provide the definition and declaration in a header file associated with the custom storage class by
using the HeaderFile attribute or custom code that you include through the model.h file. To
define the variable in the SIL or PIL application, the code generator uses the string returned by
ClassAccess(record, "groupTypeDeclDefn").

• Static initialization can assume an order of struct elements that is different from the order that
is generated if the data scope is Exported. When the code generator queries
ClassAccess(record, "groupTypeDeclDefn"), it temporarily overrides the data
initialization attribute of the custom storage class with the value None.
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To determine whether the SIL or PIL application can access the variable in the code by address, the
code generator uses the elements returned by DataAccess(record, "layout", "", ""). To
create the functionality in the application that transfers input or output port, tunable parameter, or
global data store memory values between the development computer and target hardware, the code
generator uses the output from:

• DataAccess(record, "address", idx, reim) if the first returned element is scalar,
vector, row-mat, or col-mat.

• DataAccess(record, "contents", idx, reim) (or DataAccess(record, "set", idx,
reim)) if the first returned element is other.

The code generator assumes that for row-mat and col-mat, matrices are stored in row-major format
respectively. The assumption is independent of the array layout for the rest of the model. The code
generator assumes that if the array layout of the storage implemented by the custom storage class
differs from the rest of the model, the TLC file associated with the custom storage file performs the
required transformations.

You can construct the custom TLC file associated with a custom storage class of type Other to
perform other functions (in addition to returning the requested code fragments). For example, write
directly to a custom file or call MATLAB functions that change the state of the base workspace. If you
do not always want to execute these functions when DataAccess or ClassAccess are called, use
the LibIsAccessingCustomDataForSILPIL(record) TLC function to distinguish between target
code generation and requests for code fragments for the construction of the SIL or PIL application.
For example:

...
%case "contents"
  %if !LibIsAccessingCustomDataForSILPIL(record)
    %matlab functionWithSideEffects()
  %endif
%return LibDefaultCustomStorageContents(record, idx, reim)
...

See also Other custom storage class limitations on page 80-78.

AUTOSAR Runtime Environment

You can use top-model and Model block SIL/PIL and SIL/PIL block simulations to perform model-
based testing of an AUTOSAR software component. The software links generated code for the
AUTOSAR software component with a basic component-specific AUTOSAR Runtime Environment
(RTE) to create a test application. This application tests AUTOSAR API calls made by the AUTOSAR
software component.

For a top-level AUTOSAR software component that contains referenced models, you can run top-
model or Model block (Code interface set to Top model) SIL or PIL simulations. In the simulations,
the software:

• Before compilation of referenced models, generates AUTOSAR RTE header files.
• Provides the RTE include path for referenced model compilation.

You can also run Model block (Code interface set to Model reference) SIL or PIL simulations for
a referenced model within the top-level AUTOSAR SWC. In this case, before you run a simulation, you
must build the parent component to generate the RTE header files. If you do not build the parent
component, the SIL or PIL simulation fails.
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See Also

Related Examples
• “Test Generated Code with SIL and PIL Simulations” on page 80-85
• “Choose a SIL or PIL Approach” on page 80-11
• “Configure and Run SIL Simulation” on page 80-15
• “Check Configuration” on page 80-126
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Choose a SIL or PIL Approach
In this section...
“Test Top-Model Code” on page 80-12
“Test Referenced Model Code” on page 80-12
“Test Subsystem Code” on page 80-12
“Summary” on page 80-13

Consider a top model that consists of components A, B, C, and D:

• A and B are existing components for which code has previously been generated and tested.
• C, a referenced model, and D, a subsystem, are new components.

With software-in-the-loop (SIL) and processor-in-the-loop (PIL) simulations, you can use the following
approaches to numerical equivalence testing:

• Test code from all components together. See “Test Top-Model Code” on page 80-12.
• Test new components separately (before testing code from all components). See “Test Referenced

Model Code” on page 80-12 and “Test Subsystem Code” on page 80-12.

For some forms of testing, you require a test harness model. The test harness model:

• Generates test vectors or stimulus inputs that feed the block under test.
• Makes it possible for you to observe or capture output from the block.

The following example shows a simple test harness model.

The block under test is a Model block. The Sine Wave block generates the input for the Model block.
Through the Scope block, you can observe the output from the Model block. For information about
creating and using test harnesses, see “Create Test Harnesses and Select Properties” (Simulink Test)
and “Code Generation Verification Workflow with Simulink Test” (Simulink Test).
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Test Top-Model Code
To test code generated from the top-model components together (A, B, C, and D), you can use top-
model SIL/PIL or Model block SIL/PIL.

• Top-model SIL/PIL:

1 Create test vectors or stimulus inputs in the MATLAB workspace.
2 Run the top model in normal, SIL, and PIL simulation modes. The software loads the test

vectors or stimulus inputs from the MATLAB workspace.
3 For each simulation mode, observe or capture outputs.
4 Verify numerical equivalence by comparing normal outputs against SIL and PIL outputs.

• Model block SIL/PIL:

1 Create a Model block that contains the top-model components.
2 Insert the Model block in a simulation model, for example, your test harness model.
3 Run simulations, switching the Model block between normal, SIL, and PIL modes. For the SIL

and PIL simulation modes, set the Code interface Model block parameter to Top model.
4 Verify numerical equivalence by comparing normal outputs against SIL and PIL outputs.

For more information, see “Simulation with Top Model” on page 80-15 and “SIL/PIL Manager
Verification Workflow” on page 80-67.

Test Referenced Model Code
To test code generated from the component C as part of a model reference hierarchy, use the Model
block SIL/PIL approach:

• Insert the Model block C in a simulation model, for example, your test harness model.
• Run simulations, switching the Model block between normal, SIL, and PIL modes. For the SIL and

PIL simulation modes, set the Code interface Model block parameter to Model reference.
• Verify numerical equivalence by comparing normal outputs against SIL and PIL outputs.

For more information, see “Simulation with Model Blocks” on page 80-16 and “SIL/PIL Manager
Verification Workflow” on page 80-67.

Test Subsystem Code
To test code that is generated from the subsystem D, use one of these workflows.
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Workflow Description
Simulink Test harness with
SIL/PIL Manager

Perform unit tests on subsystem code that is part of the code
generated from the parent model.

1 Generate code for the model that contains the subsystem by
running slbuild(model) or slbuild(model,
'RTWModelReferenceTargetOnly').

2 In the model, right-click the subsystem and then create a test
harness for the subsystem.

3 Open the SIL/PIL Manager. If required, enable code coverage
analysis. Then run back-to-back model and SIL or PIL
simulations.

4 If required, export an equivalence test case.

For more information, see “Test Atomic Subsystem Generated
Code” on page 80-18.

If the subsystem is not supported by this workflow, use the SIL or
PIL block workflow. For more information about unsupported
subsystems and other limitations, see “Atomic Subsystem Workflow
Limitations” on page 80-83.

SIL or PIL block Generate and test new standalone code from the subsystem.

1 Insert the subsystem in a simulation model, for example, your
test harness model.

2 Run a normal mode simulation, capturing the outputs.
3 Create a SIL or PIL block from the subsystem.
4 In the model, replace the subsystem with the SIL or PIL block.
5 Run a simulation of the model, capturing the outputs.
6 Verify numerical equivalence by comparing normal mode

subsystem outputs against SIL or PIL block outputs.

For more information, see “SIL or PIL Block Simulation” on page
80-19.

Summary
Component
From Which
Code Is
Generated

Simulation
Uses

Steps Generated
Code Interface

Test Signal
Source

Top model Top-model
SIL/PIL

In SIL/PIL Manager:

1 Select SIL/PIL Simulation
Only mode.

2 In System Under Test,
select Top model.

Standalone MATLAB
workspace
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Component
From Which
Code Is
Generated

Simulation
Uses

Steps Generated
Code Interface

Test Signal
Source

Model
referenced by
Model block

Model block
SIL/PIL

1 In SIL/PIL Manager:

a Select SIL/PIL
Simulation Only
mode.

b In System Under Test,
select Model blocks
in SIL/PIL mode.

2 In Model blocks, set
Simulation mode to
Software-in-the-loop
(SIL) or Processor-in-
the-loop (PIL).

Determined by
Model block
parameter Code
interface ––
standalone or
model reference.

Simulation model,
for example, test
harness model

Subsystem Simulink
Test
harness and
SIL/PIL
Manager

1 Generate code for model
that contains the atomic
subsystem.

2 Create a test harness for
the subsystem.

3 From SIL/PIL Manager, run
back-to-back model and SIL
or PIL simulations.

4 If required, export
equivalence test case.

Determined by
generated parent
model code ––
standalone or
model reference.

Simulink Test
harness

Subsystem SIL or PIL
block

Manual block substitution Standalone Simulation model,
for example, test
harness model.

See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Configure and Run SIL Simulation” on page 80-15
• “SIL/PIL Manager Verification Workflow” on page 80-67
• “Test Generated Code with SIL and PIL Simulations” on page 80-85
• “Code Interfaces for SIL and PIL” on page 80-5
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Configure and Run SIL Simulation
In this section...
“Simulation with Top Model” on page 80-15
“Simulation with Model Blocks” on page 80-16
“Simulation with Subsystem Blocks” on page 80-17
“Test Atomic Subsystem Generated Code” on page 80-18
“SIL or PIL Block Simulation” on page 80-19
“Configure Hardware Implementation Settings” on page 80-20
“Log Signals of a Component” on page 80-22
“Prevent Code Changes in Multiple Simulations” on page 80-23
“Speed Up Testing” on page 80-24
“Simulation with Function Calls” on page 80-24

There are three ways of running SIL and PIL simulations. You can use:

• The top model.
• Model blocks.
• SIL and PIL blocks that you create from subsystems.

Simulation with Top Model
To configure and run a top-model SIL or PIL simulation:

1 In the Simulink Editor, open your model.
2 On the Apps tab, click SIL/PIL Manager.
3 In the Mode section, select SIL/PIL Simulation Only.
4 In the Prepare section, set System Under Test to Top model.
5 In the SIL/PIL Mode field, select either Software-in-the-Loop (SIL) or Processor-in-

the-Loop (PIL). The option supports only ERT, GRT, or AUTOSAR system target files. See
“Model Configuration Parameters: Code Generation” and “Configure AUTOSAR Code
Generation” (AUTOSAR Blockset) for configuration information.

6 To monitor component signals and state data and compare values from the model and SIL or PIL
simulations:

a For each signal that you want to log:

i In the Simulink Editor, select the signal.
ii On the SIL/PIL tab, click Monitor Signals. From the gallery, select these options:

• Log Selected Signals
• Make Selected Signals Testpoints
• Signal Logging

b To log state data, from the Monitor Signals gallery, select State Logging.
c If the Language configuration parameter is C++, in the Code Mappings editor, set the Data

Visibility for the signals, states, and internal data model element categories to public.
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7 If you are configuring a SIL simulation, specify the portable word sizes option. You can then
switch seamlessly between the SIL and PIL modes. In the Configuration Parameters dialog box,
select the Enable portable word sizes check box.

8 If required, configure:

• Code coverage.
• Code execution profiling on page 74-2.
• Creation of code generation report and static code metrics on page 80-65.

9 In the Run section, in the Stop Time field, specify simulation time.
10 Click Run SIL/PIL.
11 At the end of the simulation, in the Results section, click Data Inspector to view simulation

results.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
simulation. To allow the simulation, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

You cannot:

• Close the model while the simulation is running. To interrupt the simulation, in the Command
Window, press Ctrl+C.

• Alter the model during the simulation. You can move blocks and lines as long as it does not alter
the behavior of the model.

You can run a top-model SIL or PIL simulation with the command sim(model). The software
supports the sim command option SrcWorkspace for the value 'base'.

For a PIL simulation, you control the way code compiles and executes in the target environment
through connectivity configurations.

Simulation with Model Blocks
To configure a Model block for a SIL or PIL simulation:

1 In the Simulink Editor, open your model, for example, rtwdemo_sil_modelblock.
2 Right-click your Model block, for example, Counter A. In the context menu, select Block

Parameters (ModelReference), which opens the Function Block Parameters dialog box.
3 From the Simulation Mode drop-down list, select the required mode, for example, Software-

in-the-loop (SIL).
4 From the Code interface drop-down list, specify the code that you want to test, for example,

Model reference.
5 Click OK. The software displays the simulation mode as a block label.

80 Numerical Equivalence Checking in Embedded Coder

80-16



If you select Top model, the software displays the block label (SIL: Top).
6 If you are configuring a SIL simulation, specify the portable word sizes option. You can then

switch seamlessly between the SIL and PIL modes. In the Configuration Parameters dialog box,
select the Enable portable word sizes check box.

7 On the Apps tab, click SIL/PIL Manager.
8 In the Mode section, select SIL/PIL Simulation Only.
9 In the Prepare section, set System Under Test to Model blocks in SIL/PIL mode.
10 In the Top Model Mode field, select either Normal or Accelerator.
11 If required, configure:

• Code coverage.
• Code execution profiling on page 74-2 for your Model block, by configuring execution
profiling for the top model.

• Creation of code generation report and static code metrics on page 80-65.
12 In the Run section:

• In the Stop Time field, specify simulation time.
• If you want to avoid rebuilding code after the initial build, click Fast Restart. See “Prevent

Code Changes in Multiple Simulations” on page 80-32.
• Click Run SIL/PIL.

13 At the end of the simulation, in the Results section, click Data Inspector to view simulation
results.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
simulation. To allow the simulation, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

For a PIL simulation, you control the way code compiles and executes in the target environment
through connectivity configurations.

Simulation with Subsystem Blocks
You can use one of these workflows:

• Simulink Test harness with the SIL/PIL Manager—If you have a model that contains subsystems,
you can use Simulink Test and the SIL/PIL Manager to perform unit tests on code generated from
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the subsystems. This workflow tests the generated subsystem code as part of the code generated
from the parent model. For workflow details, see “Test Atomic Subsystem Generated Code” on
page 80-18.

If this workflow does not support a subsystem, use the SIL or PIL block workflow as an
alternative.

• SIL or PIL block—Create a SIL or PIL block from the subsystem, and then run the block in an
environment or test harness model that supplies test vectors or stimulus input. This workflow
generates and tests new standalone code from the subsystem. For more information, see “SIL or
PIL Block Simulation” on page 80-19.

For a PIL simulation, you control the way code compiles and executes in the target environment
through connectivity configurations.

Test Atomic Subsystem Generated Code
To perform unit tests on code generated from an atomic subsystem:

1 Open the model that contains the atomic subsystem. For example, in the Command Window,
enter:

rtwdemo_sil_block
2 In a new folder, save the model as plant_model.
3 Modify configuration parameter settings that are not supported for this workflow. In the

Command Window, enter:

set_param('plant_model', ...
          'CreateSILPILBlock','None', ...
          'PreserveStaticInFcnDecls', 'Off');

% For this example, use these values for block parameters.
set_param('plant_model/Controller', ...
          'RTWSystemCode','Nonreusable function', ...
          'RTWFileNameOpts', 'Auto');

For more information about limitations, see “Atomic Subsystem Workflow Limitations” on page
80-83.

4 Generate code for the model that contains the atomic subsystem. In the Command Window,
enter:

slbuild('plant_model')
5 Create a test harness for the subsystem. Right-click the Controller subsystem and select Test

Harness > Create for 'Controller'.
6 Set the harness properties:

• Name –– controller_subsystem_harness
• Sources and Sinks: Inport and Outport
• Select Open harness after creation.

Click OK.

Simulink Test creates a test harness for the Controller subsystem.
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7 Specify format for saving data. In the Command Window, enter:

set_param('controller_subsystem_harness', ...
          'SaveFormat','Dataset')

8 In the Test Harness window, open the SIL/PIL Manager. On the Apps tab, click SIL/PIL
Manager.

9 If required, configure code coverage.
10 Run back-to-back model and SIL simulations:

a In the Mode section, select Automated Verification.
b In the Run Automated Verification section, click Run Verification.

11 From the Results gallery, you can:

• Use the Simulation Data Inspector to analyze results. For example, compare the
controller_model_output signals from the model and SIL simulations.

• Export an equivalence test case.

For more information, see “Analyze Results and Export Test Cases” on page 80-70.

SIL or PIL Block Simulation
To create a SIL or PIL block from a subsystem and use this block to test the code generated from the
subsystem:

1 From the Configuration Parameters > Code Generation > Verification > Advanced
Parameters > Create block drop-down list, select either SIL or PIL.

2 If required, configure code execution profiling.
3 Click OK.
4 In your model window, right-click the subsystem that you want to simulate.
5 Select C/C++ Code > Build This Subsystem.
6 Click Build, which starts the subsystem build process that creates a SIL or PIL block for the

generated subsystem code.
7 Add the generated block to an environment or test harness model that supplies test vectors or

stimulus input.
8 Run simulations with the environment or test harness model.
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Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
simulation. To allow the simulation, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

You cannot create a SIL or PIL block if you do one of the following:

• Disable the CreateSILPILBlock property.
• Select a code coverage tool.

Create block appears dimmed.

Configure Hardware Implementation Settings
For a SIL simulation, you must configure hardware implementation settings, which enables generated
code compilation for your development computer. These settings can differ from the hardware
implementation settings that you use when building the model for your production hardware. Use one
of these approaches.

Approach Details
Portable word
sizes

Switch between SIL and PIL modes without regenerating code. You use the same
generated source code files for the SIL simulation on your development computer
and for production deployment on the target platform.

To configure a model to use portable word sizes, set:

• ProdEqTarget to 'on'.
• PortableWordSizes to 'on'.
When you generate code for a model with portable word sizes specified, the code
generator conditionalizes data type definitions in rtwtypes.h:

#ifdef PORTABLE_WORDSIZES           /* PORTABLE_WORDSIZES defined */

…

#else                               /* PORTABLE_WORDSIZES not defined */

…

#endif                              /* PORTABLE_WORDSIZES */

The template makefile that you use to build code for your target must not contain
the PORTABLE_WORDSIZES definition.

For the template makefile and toolchain approaches to building code, the software
specifies -DPORTABLE_WORDSIZES for the compiler only for host-based builds.

For information about the template makefile and toolchain approaches to building
code, see “Choose Build Approach and Configure Build Process”.
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Approach Details
Consider the case where your target uses code that your development computer
cannot compile. When you switch from the PIL mode to the SIL mode and try to
simulate the model, you see compilation errors. You can try to work around this
problem by adding the source code files to the SkipForSil group in the build
information object RTW.BuildInfo. The SIL build on the host platform does not
compile source files present in the SkipForSil group. For information about how
you add source code files to a group in the build information object, see:

• addSourceFiles in the Simulink Coder documentation
• “Customize Post-Code-Generation Build Processing” in the Simulink Coder

documentation
Numerical results can differ between generated code executing in a SIL simulation
and generated code executing on the production hardware under one of these
conditions:

• Your model contains blocks implemented in TLC, for which C integral promotion
in expressions can behave differently between the MATLAB host and the
production hardware target. Normal and PIL simulation results match, but SIL
simulation results can differ.

• Your production hardware implements rounding to Floor for signed integer
division, and divisions in your model use rounding mode Ceiling, Floor,
Simplest, or Zero. Normal and PIL simulation results match, but SIL
simulation results can differ.

• The byte ordering for your production hardware is Big Endian. Normal and PIL
simulation results match, but SIL simulation results can differ. For example,
when generated code depends on byte order and generated production code is
implemented with the aim that its behavior matches normal simulation behavior.

• You use custom code with the Stateflow product. In this case, type conversion
statements are not inserted into the custom code, which target overflow behavior
on the host can require. Normal and PIL simulation results match, but SIL
simulation results can differ.

Test hardware Use this approach only when you want to work around a limitation of portable word
sizes.

Set:

• PortableWordSizes to 'off'.
• ProdEqTarget to 'off'.
• TargetHWDeviceType to 'Custom Processor->MATLAB Host Processor'.

Production
hardware

Use this approach only when the production hardware settings match your
development computer architecture.

Set:

• PortableWordSizes to 'off'.
• ProdEqTarget to 'on'.
• ProdHWDeviceType to match your development computer architecture.
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For information about test and production targets, see “Configure Run-Time Environment Options” in
the Simulink Coder documentation.

Log Signals of a Component
SIL and PIL component outputs are available for observation and comparison with other simulation
mode outputs. If you want to examine an internal signal, you can enable internal signal logging for
top-model or Model block SIL or PIL. With signal logging, you can:

• Collect signal logging outputs during SIL/PIL simulations, for example, logsout.
• Log the internal signals and the root-level outputs of a SIL/PIL component.
• Manage the SIL/PIL signal logging settings with the Simulink Signal Logging Selector.
• Use the Simulation Data Inspector to:

• Observe streamed signals during normal, SIL, and PIL simulations.
• Compare logged signals from normal, SIL, and PIL simulations.

To enable signal logging to the MATLAB workspace and signal streaming to the Simulation Data
Inspector during SIL or PIL simulations:

1 For each signal that you want to monitor:

a In the Simulink Editor, select the signal.
b On the SIL/PIL tab, click Monitor Signals. From the gallery, select these options:

• Log Selected Signals
• Make Selected Signals Testpoints
• Signal Logging

2 If the Language configuration parameter is C++, in the Code Mappings editor, set the Data
Visibility for the signals, states, and internal data model element categories to public.

You can use other methods to examine internal signals of the SIL or PIL component:

• Manually route the signal to the top level.
• Use global data stores to access internal signals:

1 Inside the component, connect a Data Store Write block to the required signal.
2 Outside the component, use a Data Store Read block to access the signal value.

• Use MAT-file logging. Note that:

• MAT-file logging does not support signal logging. If signal logging is enabled, logsout is
generated but not stored in the MAT-file.

• For PIL, the target environment must support MAT-file logging.

For more information, see:

• “Configure Signals as Test Points”
• “Export Signal Data Using Signal Logging”
• “Local and Global Data Stores”
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• “Global Data Store Example”
• “Log Program Execution Results”

Prevent Code Changes in Multiple Simulations
Use Model block SIL/PIL or the SIL/PIL block with fast restart when you want to run multiple SIL or
PIL simulations with:

• Varying test vectors (parameter sets and input data).
• Unchanged generated code, that is, none of the simulations regenerate or rebuild code after the

initial build. For example, you want to avoid the incremental code generation that an initial value
change can trigger.

For Model block SIL/PIL, you can also use one of these methods:

• In your test harness model, in the Configuration Parameters dialog box, set Rebuild to Never. If
the Model block Code interface parameter is Model reference, the software does not rebuild
the referenced model code. (If the Code interface parameter is Top model, the software ignores
the Rebuild setting.)

• Create a protected model and generate source or binary code. Then, insert the protected model in
your test harness model. With this method, you can verify top-model code (with the standalone
code interface) or model reference code.

For the alternative methods of running Model block SIL/PIL, the following table summarizes code
generation behavior after the initial build.

SIL and PIL Approach Code Generation Behavior
After Initial Build

Model block Rebuild configuration
parameter of test harness model
set to Never.

1 Component (algorithm)
code from initial build is not
regenerated.

2 Component code makefile is
not called.

3 SIL/PIL application files
from initial build are not
regenerated.

4 SIL/PIL application makefile
is called.

Model block (protected model) Source code from protected
model.

You observe the same behavior
except for feature 2. In this
case, the component code
makefile is run. The component
code is recompiled and linked to
produce new object code.

Binary code from protected
model.

You observe features 1–4.

For more information, see:
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• “Model Configuration Parameters: Model Referencing”
• “Protect Models to Conceal Contents”

Speed Up Testing
If your model has SIL/PIL blocks or Model blocks in SIL/PIL mode, you can speed up SIL/PIL testing
by:

• Running the top-model simulation in accelerator mode. This mode accelerates the simulation of
model components that are not in SIL or PIL mode.

• Turning on fast restart. After the first simulation, you can tune parameters and rerun simulations
without model recompilation. The SIL/PIL Manager provides a Fast Restart button.

Note The SIL and PIL simulation modes are not designed for the reduction of model simulation
times. If you want to speed up the simulation of your model, use the rapid accelerator mode. For
more information, see “What Is Acceleration?”.

Simulation with Function Calls
Use the Simulink Function block and Function Caller block when you want to:

• Generate code that makes a function-call to external code, for example, driver or legacy code.
• Provide a subsystem that behaves like the external code in normal, SIL, or PIL simulations.

The example in “Configure Calls to AUTOSAR NVRAM Manager Service” (AUTOSAR Blockset) shows
how you can configure client calls to Basic Software (BSW) NVRAM Manager (NvM) service
interfaces from your AUTOSAR software component. In a simulation, Simulink implements the BSW
NvM calls through Simulink Function and preconfigured Function Caller blocks. For the final system,
you link function-call stubs with external BSW function code that runs in the AUTOSAR Runtime
Environment (RTE).

For more information, see “Simulink Function Blocks and Code Generation”.

See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
• “Test Generated Code with SIL and PIL Simulations” on page 80-85
• “Debug Generated Code During SIL Simulation” on page 80-37
• “View SIL and PIL Files in Code Generation Report” on page 80-65
• “SIL/PIL Manager Verification Workflow” on page 80-67
• “Run Simulations Programmatically”
• “Simulation Mode Override Behavior in Model Reference Hierarchy” on page 80-35
• “SIL and PIL Limitations” on page 80-74
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• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “Code Execution Profiling with SIL and PIL” on page 74-2
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Configure and Run PIL Simulation
In this section...
“Simulation with Top Model” on page 80-26
“Simulation with Model Blocks” on page 80-27
“Simulation with Subsystem Blocks” on page 80-28
“Test Atomic Subsystem Generated Code” on page 80-29
“SIL or PIL Block Simulation” on page 80-30
“Log Signals of a Component” on page 80-31
“Prevent Code Changes in Multiple Simulations” on page 80-32
“Speed Up Testing” on page 80-33
“Simulation with Function Calls” on page 80-33

There are three ways of running SIL and PIL simulations. You can use:

• The top model.
• Model blocks.
• SIL and PIL blocks that you create from subsystems.

Simulation with Top Model
To configure and run a top-model SIL or PIL simulation:

1 In the Simulink Editor, open your model.
2 On the Apps tab, click SIL/PIL Manager.
3 In the Mode section, select SIL/PIL Simulation Only.
4 In the Prepare section, set System Under Test to Top model.
5 In the SIL/PIL Mode field, select either Software-in-the-Loop (SIL) or Processor-in-

the-Loop (PIL). The option supports only ERT, GRT, or AUTOSAR system target files. See
“Model Configuration Parameters: Code Generation” and “Configure AUTOSAR Code
Generation” (AUTOSAR Blockset) for configuration information.

6 To monitor component signals and state data and compare values from the model and SIL or PIL
simulations:

a For each signal that you want to log:

i In the Simulink Editor, select the signal.
ii On the SIL/PIL tab, click Monitor Signals. From the gallery, select these options:

• Log Selected Signals
• Make Selected Signals Testpoints
• Signal Logging

b To log state data, from the Monitor Signals gallery, select State Logging.
c If the Language configuration parameter is C++, in the Code Mappings editor, set the Data

Visibility for the signals, states, and internal data model element categories to public.
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7 If you are configuring a SIL simulation, specify the portable word sizes option. You can then
switch seamlessly between the SIL and PIL modes. In the Configuration Parameters dialog box,
select the Enable portable word sizes check box.

8 If required, configure:

• Code coverage.
• Code execution profiling on page 74-2.
• Creation of code generation report and static code metrics on page 80-65.

9 In the Run section, in the Stop Time field, specify simulation time.
10 Click Run SIL/PIL.
11 At the end of the simulation, in the Results section, click Data Inspector to view simulation

results.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
simulation. To allow the simulation, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

You cannot:

• Close the model while the simulation is running. To interrupt the simulation, in the Command
Window, press Ctrl+C.

• Alter the model during the simulation. You can move blocks and lines as long as it does not alter
the behavior of the model.

You can run a top-model SIL or PIL simulation with the command sim(model). The software
supports the sim command option SrcWorkspace for the value 'base'.

For a PIL simulation, you control the way code compiles and executes in the target environment
through connectivity configurations.

Simulation with Model Blocks
To configure a Model block for a SIL or PIL simulation:

1 In the Simulink Editor, open your model, for example, rtwdemo_sil_modelblock.
2 Right-click your Model block, for example, Counter A. In the context menu, select Block

Parameters (ModelReference), which opens the Function Block Parameters dialog box.
3 From the Simulation Mode drop-down list, select the required mode, for example, Software-

in-the-loop (SIL).
4 From the Code interface drop-down list, specify the code that you want to test, for example,

Model reference.
5 Click OK. The software displays the simulation mode as a block label.
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If you select Top model, the software displays the block label (SIL: Top).
6 If you are configuring a SIL simulation, specify the portable word sizes option. You can then

switch seamlessly between the SIL and PIL modes. In the Configuration Parameters dialog box,
select the Enable portable word sizes check box.

7 On the Apps tab, click SIL/PIL Manager.
8 In the Mode section, select SIL/PIL Simulation Only.
9 In the Prepare section, set System Under Test to Model blocks in SIL/PIL mode.
10 In the Top Model Mode field, select either Normal or Accelerator.
11 If required, configure:

• Code coverage.
• Code execution profiling on page 74-2 for your Model block, by configuring execution
profiling for the top model.

• Creation of code generation report and static code metrics on page 80-65.
12 In the Run section:

• In the Stop Time field, specify simulation time.
• If you want to avoid rebuilding code after the initial build, click Fast Restart. See “Prevent

Code Changes in Multiple Simulations” on page 80-32.
• Click Run SIL/PIL.

13 At the end of the simulation, in the Results section, click Data Inspector to view simulation
results.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
simulation. To allow the simulation, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

For a PIL simulation, you control the way code compiles and executes in the target environment
through connectivity configurations.

Simulation with Subsystem Blocks
You can use one of these workflows:

• Simulink Test harness with the SIL/PIL Manager—If you have a model that contains subsystems,
you can use Simulink Test and the SIL/PIL Manager to perform unit tests on code generated from
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the subsystems. This workflow tests the generated subsystem code as part of the code generated
from the parent model. For workflow details, see “Test Atomic Subsystem Generated Code” on
page 80-29.

If this workflow does not support a subsystem, use the SIL or PIL block workflow as an
alternative.

• SIL or PIL block—Create a SIL or PIL block from the subsystem, and then run the block in an
environment or test harness model that supplies test vectors or stimulus input. This workflow
generates and tests new standalone code from the subsystem. For more information, see “SIL or
PIL Block Simulation” on page 80-30.

For a PIL simulation, you control the way code compiles and executes in the target environment
through connectivity configurations.

Test Atomic Subsystem Generated Code
To perform unit tests on code generated from an atomic subsystem:

1 Open the model that contains the atomic subsystem. For example, in the Command Window,
enter:

rtwdemo_sil_block
2 In a new folder, save the model as plant_model.
3 Modify configuration parameter settings that are not supported for this workflow. In the

Command Window, enter:

set_param('plant_model', ...
          'CreateSILPILBlock','None', ...
          'PreserveStaticInFcnDecls', 'Off');

% For this example, use these values for block parameters.
set_param('plant_model/Controller', ...
          'RTWSystemCode','Nonreusable function', ...
          'RTWFileNameOpts', 'Auto');

For more information about limitations, see “Atomic Subsystem Workflow Limitations” on page
80-83.

4 Generate code for the model that contains the atomic subsystem. In the Command Window,
enter:

slbuild('plant_model')
5 Create a test harness for the subsystem. Right-click the Controller subsystem and select Test

Harness > Create for 'Controller'.
6 Set the harness properties:

• Name –– controller_subsystem_harness
• Sources and Sinks: Inport and Outport
• Select Open harness after creation.

Click OK.

Simulink Test creates a test harness for the Controller subsystem.
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7 Specify format for saving data. In the Command Window, enter:

set_param('controller_subsystem_harness', ...
          'SaveFormat','Dataset')

8 In the Test Harness window, open the SIL/PIL Manager. On the Apps tab, click SIL/PIL
Manager.

9 If required, configure code coverage.
10 Run back-to-back model and SIL simulations:

a In the Mode section, select Automated Verification.
b In the Run Automated Verification section, click Run Verification.

11 From the Results gallery, you can:

• Use the Simulation Data Inspector to analyze results. For example, compare the
controller_model_output signals from the model and SIL simulations.

• Export an equivalence test case.

For more information, see “Analyze Results and Export Test Cases” on page 80-70.

SIL or PIL Block Simulation
To create a SIL or PIL block from a subsystem and use this block to test the code generated from the
subsystem:

1 From the Configuration Parameters > Code Generation > Verification > Advanced
Parameters > Create block drop-down list, select either SIL or PIL.

2 If required, configure code execution profiling.
3 Click OK.
4 In your model window, right-click the subsystem that you want to simulate.
5 Select C/C++ Code > Build This Subsystem.
6 Click Build, which starts the subsystem build process that creates a SIL or PIL block for the

generated subsystem code.
7 Add the generated block to an environment or test harness model that supplies test vectors or

stimulus input.
8 Run simulations with the environment or test harness model.
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Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
simulation. To allow the simulation, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

You cannot create a SIL or PIL block if you do one of the following:

• Disable the CreateSILPILBlock property.
• Select a code coverage tool.

Create block appears dimmed.

Log Signals of a Component
SIL and PIL component outputs are available for observation and comparison with other simulation
mode outputs. If you want to examine an internal signal, you can enable internal signal logging for
top-model or Model block SIL or PIL. With signal logging, you can:

• Collect signal logging outputs during SIL/PIL simulations, for example, logsout.
• Log the internal signals and the root-level outputs of a SIL/PIL component.
• Manage the SIL/PIL signal logging settings with the Simulink Signal Logging Selector.
• Use the Simulation Data Inspector to:

• Observe streamed signals during normal, SIL, and PIL simulations.
• Compare logged signals from normal, SIL, and PIL simulations.

To enable signal logging to the MATLAB workspace and signal streaming to the Simulation Data
Inspector during SIL or PIL simulations:

1 For each signal that you want to monitor:

a In the Simulink Editor, select the signal.
b On the SIL/PIL tab, click Monitor Signals. From the gallery, select these options:

• Log Selected Signals
• Make Selected Signals Testpoints
• Signal Logging

2 If the Language configuration parameter is C++, in the Code Mappings editor, set the Data
Visibility for the signals, states, and internal data model element categories to public.

You can use other methods to examine internal signals of the SIL or PIL component:

• Manually route the signal to the top level.
• Use global data stores to access internal signals:

1 Inside the component, connect a Data Store Write block to the required signal.
2 Outside the component, use a Data Store Read block to access the signal value.

• Use MAT-file logging. Note that:

• MAT-file logging does not support signal logging. If signal logging is enabled, logsout is
generated but not stored in the MAT-file.
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• For PIL, the target environment must support MAT-file logging.

For more information, see:

• “Configure Signals as Test Points”
• “Export Signal Data Using Signal Logging”
• “Local and Global Data Stores”
• “Global Data Store Example”
• “Log Program Execution Results”

Prevent Code Changes in Multiple Simulations
Use Model block SIL/PIL or the SIL/PIL block with fast restart when you want to run multiple SIL or
PIL simulations with:

• Varying test vectors (parameter sets and input data).
• Unchanged generated code, that is, none of the simulations regenerate or rebuild code after the

initial build. For example, you want to avoid the incremental code generation that an initial value
change can trigger.

For Model block SIL/PIL, you can also use one of these methods:

• In your test harness model, in the Configuration Parameters dialog box, set Rebuild to Never. If
the Model block Code interface parameter is Model reference, the software does not rebuild
the referenced model code. (If the Code interface parameter is Top model, the software ignores
the Rebuild setting.)

• Create a protected model and generate source or binary code. Then, insert the protected model in
your test harness model. With this method, you can verify top-model code (with the standalone
code interface) or model reference code.

For the alternative methods of running Model block SIL/PIL, the following table summarizes code
generation behavior after the initial build.

SIL and PIL Approach Code Generation Behavior
After Initial Build

Model block Rebuild configuration
parameter of test harness model
set to Never.

1 Component (algorithm)
code from initial build is not
regenerated.

2 Component code makefile is
not called.

3 SIL/PIL application files
from initial build are not
regenerated.

4 SIL/PIL application makefile
is called.
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SIL and PIL Approach Code Generation Behavior
After Initial Build

Model block (protected model) Source code from protected
model.

You observe the same behavior
except for feature 2. In this
case, the component code
makefile is run. The component
code is recompiled and linked to
produce new object code.

Binary code from protected
model.

You observe features 1–4.

For more information, see:

• “Model Configuration Parameters: Model Referencing”
• “Protect Models to Conceal Contents”

Speed Up Testing
If your model has SIL/PIL blocks or Model blocks in SIL/PIL mode, you can speed up SIL/PIL testing
by:

• Running the top-model simulation in accelerator mode. This mode accelerates the simulation of
model components that are not in SIL or PIL mode.

• Turning on fast restart. After the first simulation, you can tune parameters and rerun simulations
without model recompilation. The SIL/PIL Manager provides a Fast Restart button.

Note The SIL and PIL simulation modes are not designed for the reduction of model simulation
times. If you want to speed up the simulation of your model, use the rapid accelerator mode. For
more information, see “What Is Acceleration?”.

Simulation with Function Calls
Use the Simulink Function block and Function Caller block when you want to:

• Generate code that makes a function-call to external code, for example, driver or legacy code.
• Provide a subsystem that behaves like the external code in normal, SIL, or PIL simulations.

The example in “Configure Calls to AUTOSAR NVRAM Manager Service” (AUTOSAR Blockset) shows
how you can configure client calls to Basic Software (BSW) NVRAM Manager (NvM) service
interfaces from your AUTOSAR software component. In a simulation, Simulink implements the BSW
NvM calls through Simulink Function and preconfigured Function Caller blocks. For the final system,
you link function-call stubs with external BSW function code that runs in the AUTOSAR Runtime
Environment (RTE).

For more information, see “Simulink Function Blocks and Code Generation”.
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See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Test Generated Code with SIL and PIL Simulations” on page 80-85
• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “Code Execution Profiling with SIL and PIL” on page 74-2
• “View SIL and PIL Files in Code Generation Report” on page 80-65
• “SIL/PIL Manager Verification Workflow” on page 80-67
• “Run Simulations Programmatically”
• “Simulation Mode Override Behavior in Model Reference Hierarchy” on page 80-35
• “SIL and PIL Limitations” on page 80-74
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Simulation Mode Override Behavior in Model Reference
Hierarchy

When the top model contains a Model block, the simulation mode of the top model can override the
simulation mode of the Model block. The model referenced by the Model block can be a parent model
that contains Model blocks at lower levels of the model hierarchy. When you simulate the model
hierarchy, the simulation mode used by a parent model can override the simulation mode of any
Model blocks it contains.

You can specify the simulation mode of a top model to be normal, accelerator, rapid accelerator, SIL,
or PIL. With a Model block, you can specify all modes except rapid accelerator. This table shows how
the software determines the effective simulation mode of a Model block in a model hierarchy.

Simulation Mode
Used by Parent
Model

Simulation Mode of Model Block
Normal Accelerator SIL PIL

Normal Compatible Compatible Compatible Compatible
Accelerator Overridden Compatible Compatible if top

model mode is
accelerator.

Error if parent
block mode is
accelerator.

Compatible if top
model mode is
accelerator.

Error if parent
block mode is
accelerator.

Rapid
accelerator (top
model only)

Overridden Compatible Error Error

SIL Overridden Overridden Compatible Error
PIL Overridden Overridden Error Compatible

The different types of behavior are:

• Compatible — The software simulates the Model block in the mode specified for it.
• Error — The simulation produces an error. For example, if a top model specifies rapid accelerator

mode but contains a Model block in SIL or PIL mode, then running a simulation produces an error:
the rapid accelerator mode cannot override the SIL and PIL mode of Model blocks. This behavior
avoids the risk of false positives, that is, the simulation of a model in rapid accelerator mode does
not lead to the conclusion that generated source or object code of Model blocks is tested or
verified.

• Overridden — The simulation mode of the top model or parent model overrides the simulation
mode of the Model block. For example, if a top model or parent model that you configured for a
SIL simulation contains a Model block with normal or accelerator simulation mode, then the
software simulates the referenced model in SIL mode. The override behavior:

• Allows a Model block in the model hierarchy to have SIL or PIL mode.
• Makes lower-level referenced models execute in SIL or PIL mode if you simulate the top model

or parent model in SIL or PIL mode. You do not have to switch the simulation mode of every
referenced model in the hierarchy.
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Multiple Model blocks, starting at the top of a model hierarchy, can execute in SIL or PIL mode.
However, if code coverage or code execution profiling is enabled, only one Model block can execute
at a time in SIL or PIL mode.

Note You can view your model hierarchy in the Dependency Analyzer. In the Model Instances view,
the software displays Model blocks differently to indicate their simulation modes, for example,
normal, accelerator, SIL, and PIL. In this view, the software does not indicate the simulation mode of
the top model.

See Also

More About
• “What Is Acceleration?”
• “SIL and PIL Simulations” on page 80-2
• “Model Block SIL/PIL Limitations” on page 80-82
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Debug Generated Code During SIL Simulation
If a software-in-the-loop (SIL) simulation fails or you notice differences between the outputs of your
original functions and the generated code, you can rerun the SIL simulation with a debugger enabled.
By inserting breakpoints, you can observe the behavior of code sections, which can help you to
understand the cause of the issue.

For a SIL simulation failure, you can also view information from the standard output and standard
error streams in the Diagnostic Viewer. For example:

• Output from printf statements in your code.
• Error messages sent to stderr.
• Some low-level system messages.

During a SIL simulation, the SIL application redirects the stdout and stderr streams. When the
application terminates, the Diagnostic Viewer displays the information from the redirected streams.
The SIL application also provides a basic signal handler, which captures the POSIX® signals SIGFPE,
SIGILL, SIGABRT, and SIGSEV. For this signal handler, the SIL application includes the file
signal.h.

A SIL simulation supports these debuggers;

• On Windows, Microsoft Visual Studio debugger.
• On Linux, GNU Data Display Debugger (DDD).

Note You can perform SIL debugging only if the Simulink product family supports your Microsoft
Visual C++ or GNU GCC compiler. For more information, see supported compilers.

To enable your debugger for a SIL simulation, perform one of these actions:

• On the SIL/PIL tab, click Settings > SIL Debugging.
• In the Configuration Parameters dialog box, select the Enable source-level debugging for SIL

check box.

If your top model has Model blocks, the Enable source-level debugging for SIL parameter for the
top model overrides the corresponding parameter for referenced models.

When you run the SIL simulation, for example on a Windows computer, your model.c or model.cpp
file opens in the Microsoft Visual Studio IDE with debugger breakpoints at the start of the
model_initialize and model_step functions.
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You can now use the debugger features to observe code behavior. For example, you can step through
code and examine variables.

To end the debugging session:

1 Remove all breakpoints.
2 Click the Continue button (F5).

The SIL simulation runs to completion and the Microsoft Visual Studio IDE closes.

Note In the Microsoft Visual Studio IDE, if you select Debug > Stop Debugging, the SIL simulation
times out with the following error message:

The timeout of 1 seconds for receiving data from the rtiostream 
interface has been exceeded. There are multiple possible causes 
for this failure.
... 
...

See Also

Related Examples
• “Configure and Run SIL Simulation” on page 80-15
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Create PIL Target Connectivity Configuration for Simulink
In this section...
“Target Connectivity Configurations for PIL” on page 80-39
“Create a Target Connectivity API Implementation” on page 80-39
“Register a Connectivity API Implementation” on page 80-41
“Verify Target Connectivity Configuration” on page 80-41
“Target Connectivity API Examples” on page 80-41

Target Connectivity Configurations for PIL
Use target connectivity configurations and the target connectivity API to customize processor-in-the-
loop (PIL) simulation for your target environments.

Through a target connectivity configuration, you specify:

• A configuration name for a target connectivity API implementation.
• Settings that define the set of compatible Simulink models. For example, the set of models that

have a particular system target file, template makefile, and hardware implementation.

A PIL simulation requires a target connectivity API implementation that integrates third-party tools
for:

• Cross-compiling generated code, creating the PIL application that runs on the target hardware.
• Downloading, starting, and stopping the application on the target.
• Communicating between Simulink and the target.

You can have many different target connectivity configurations for PIL simulation. Register a
connectivity configuration with Simulink by creating an sl_customization.m file and placing it on
the MATLAB search path.

When you run a PIL simulation, the software determines which of the available connectivity
configurations to use. The software looks for a connectivity configuration that is compatible with the
model under test. If the software finds multiple or no compatible connectivity configurations, the
software generates an error message with information about resolving the problem.

Create a Target Connectivity API Implementation
This diagram shows the components of the PIL target connectivity API.
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You must provide implementations of the three API components:

• Build API — Specify the Simulink Coder toolchain or template makefile approach for building
generated code.

• Launcher API — Control how Simulink starts and stops the PIL executable.
• Communications API — Customize connectivity between Simulink and the PIL target. Embedded

Coder provides host-side support for TCP/IP and serial communications, which you can adapt for
other protocols.

These steps outline how you create a target connectivity API implementation. The example code
shown in the steps is taken from ConnectivityConfig.m in “Configure Processor-In-The-Loop (PIL)
for a Custom Target” on page 80-104.

1 Create a subclass of rtw.connectivity.Config.
ConnectivityConfig < rtw.connectivity.Config

2 In the subclass:

• Instantiate rtw.connectivity.MakefileBuilder, which configures the build process.
builder = rtw.connectivity.MakefileBuilder(componentArgs, ...
                                           targetApplicationFramework, ...
                                           exeExtension);

• Create a subclass of rtw.connectivity.Launcher, which downloads and executes the
application using a third-party tool.
launcher = mypil.Launcher(componentArgs, builder);

3 Configure your rtiostream API implementation of the host-target communications on page 80-
43 channel.

80 Numerical Equivalence Checking in Embedded Coder

80-40



• For the target side, you must provide the driver code for communications, for example,
TCP/IP or serial communications. To integrate this code into the build process, create a
subclass of rtw.pil.RtIOStreamApplicationFramework.

• For the host side, you can use a supplied library for TCP/IP or serial communications.
Instantiate rtw.connectivity.RtIOStreamHostCommunicator, which loads and
initializes the library that you specify.
hostCommunicator = rtw.connectivity.RtIOStreamHostCommunicator(componentArgs, ...
                                                               launcher, ...
                                                               rtiostreamLib);

4 If you require execution-time profiling of generated code, create a timer object that provides
details of the hardware-specific timer and associated source files. See “Specify Hardware Timer”
on page 80-46.

Note Each time you modify a connectivity implementation, close and reopen the models to refresh
them.

Register a Connectivity API Implementation
To register a target connectivity API implementation as a target connectivity configuration in
Simulink:

1 Create or update an sl_customization.m file. In this file:

• Create a target connectivity configuration object that specifies, for example, the configuration
name for a target connectivity API implementation and compatible models.

• Invoke registerTargetInfo.
2 Add the folder containing sl_customization.m to the search path and refresh your

customizations.

addpath(sl_customization_path);
sl_refresh_customizations;

For more information, see rtw.connectivity.ConfigRegistry.

Verify Target Connectivity Configuration
To verify your target connectivity configuration early on and independently of your model
development and code generation, use the supplied piltest function. With the function, you can run
a suite of tests. In the tests, the function runs various normal, SIL, and PIL simulations. The function
compares results and produces errors if it detects differences between simulation modes.

Target Connectivity API Examples
For step-by-step examples, see:

• “Configure Processor-In-The-Loop (PIL) for a Custom Target” on page 80-104

This example shows you how to create a custom PIL implementation using the target connectivity
APIs. You can examine the code that configures the build process to support PIL, a downloading
and execution tool, and a communication channel between host and target. To activate a full host-
based PIL configuration, follow the steps in the example.
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• “Create a Target Communication Channel for Processor-In-The-Loop (PIL) Simulation” on page 80-
99

This example shows you how to implement a communication channel for use with the Embedded
Coder product and your embedded target. This communication channel enables exchange of data
between different processes. PIL simulation requires exchange of data between the Simulink
software running on your development computer and deployed code executing on target
hardware.

The rtiostream interface provides a generic communication channel that you can implement in
the form of target connectivity drivers for a range of connection types. The example shows how to
configure your own target-side driver for TCP/IP, to operate with the default host-side TCP/IP
driver. The default TCP/IP communications allow high-bandwidth communication between host
and target, which you can use for transferring data such as video.

Note If you customize the rtiostream TCP/IP implementation for your PIL simulations, you
must turn off Nagle's algorithm for the server side of the connection. If Nagle's algorithm is not
turned off, your PIL simulations can run at a significantly slower speed. The matlabroot/
toolbox/coder/rtiostream/src/rtiostreamtcpip/rtiostream_tcpip.c file shows how
you can turn off Nagle's algorithm:
/* Disable Nagle's Algorithm*/
option = 1;
sockStatus = setsockopt(lFd,IPPROTO_TCP,TCP_NODELAY,(char*)&option,sizeof(option));  

The code for your custom TCP/IP implementation can require modification.

The example also shows how to implement custom target connectivity drivers, for example, using
serial, CAN, or USB for both host and target sides of the communication channel.

See Also
piltest | rtw.connectivity.Config | rtw.connectivity.ConfigRegistry |
rtw.connectivity.Launcher | rtw.connectivity.MakefileBuilder |
rtw.connectivity.RtIOStreamHostCommunicator |
rtw.pil.RtIOStreamApplicationFramework

Related Examples
• “Host-Target Communication for Simulink PIL simulation” on page 80-43
• “Specify Hardware Timer” on page 80-46
• “Design Subclass Constructors”
• “Processor-in-the-Loop Verification of Simulink Models” (Embedded Coder Support Package for

ARM Cortex-A Processors)
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Host-Target Communication for Simulink PIL simulation
In this section...
“Communications rtiostream API” on page 80-43
“Synchronize Host and Target” on page 80-44
“Test an rtiostream Driver” on page 80-44
“Word Addressable Target Hardware” on page 80-44

This section provides information about using the rtiostream API for communication between your
development computer and target hardware during a PIL simulation.

Communications rtiostream API
The rtiostream API supports communications for the target connectivity API. Use the rtiostream
API to implement a communication channel that enables data exchange between different processes.

PIL simulation requires a host-target communications channel. This communications channel
comprises driver code that runs on the host and target. The rtiostream API defines the signature of
target-side and host-side functions that this driver code must implement.

The API is independent of the physical layer that sends the data. Possible physical layers include
RS232, Ethernet, or Controller Area Network (CAN).

A full rtiostream implementation requires both host-side and target-side drivers. Code generation
software includes host-side drivers for the default TCP/IP implementation and a version for serial
communications. To use:

• The TCP/IP rtiostream communications channel, you must provide, or obtain from a third party,
target-specific TCP/IP device drivers.

• The serial communications channel, you must provide, or obtain from a third party, target-specific
serial device drivers.

For other communication channels and platforms, the code generation software does not provide
default implementations. You must provide both the host-side and the target-side drivers.

The rtiostream API comprises the following functions:

• rtIOStreamOpen
• rtIOStreamSend
• rtIOStreamRecv
• rtIOStreamClose

For information about:

• Using rtiostream functions in a connectivity implementation, see “Create a Target Connectivity
API Implementation” on page 80-39.

• Testing the rtiostream shared library methods from MATLAB code, see rtiostream_wrapper.
• Debugging and verifying the behavior of custom rtiostream interface implementations, see

“Test an rtiostream Driver” on page 80-44 and rtiostreamtest.
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Synchronize Host and Target
If you use the rtiostream API to implement the communications channel, the host and target must
be synchronized, which prevents Simulink from transmitting and receiving data before the target
application is fully initialized.

To synchronize the host and target for TCP/IP rtiostream implementations, use the
setInitCommsTimeout method from rtw.connectivity.RtIOStreamHostCommunicator. This
approach works well for connection-oriented TCP/IP rtiostream implementations because Simulink
automatically waits until the target server is running.

With other rtiostream implementations, for example, serial, the Simulink side of the rtiostream
connection opens without waiting for the target to be fully initialized. In this case, you must make
your Launcher implementation wait until the target application is fully initialized. Use one of the
following approaches to synchronize your host and target:

• Add a pause at the end of the Launcher implementation that makes the Launcher wait until
target initialization is complete.

• In the Launcher implementation, use third-party downloader or debugger APIs that wait until
target initialization is complete.

• Implement a handshaking mechanism in the Launcher / rtiostream implementation that
confirms completion of target initialization.

Test an rtiostream Driver
Use a test suite to debug and verify the behavior of custom rtiostream interface implementations.

The test suite can help you to:

• Reduce the time required for integrating custom hardware that does not have built-in
rtiostream support.

• Reduce the time required for testing custom rtiostream drivers.
• Analyze the performance of custom rtiostream drivers.

The test suite consists of two parts. One part is an application that runs on the target hardware. The
other part runs in MATLAB. For details, see rtiostreamtest.

Word Addressable Target Hardware
In the Configuration Parameters dialog box, when you specify settings for Device vendor and Device
type, you provide PIL simulations with memory addressing information about the target hardware.

For example, consider the case when Device vendor is set to Texas Instruments and Device type
is set to C5000.

The settings specify that the target hardware uses 16-bit word addresses and big-endian word order.
The rtiostream implementation operates with 16-bit words.

On the target hardware, if an rtIOStream function specifies a size of 1, then the target hardware
must send or receive one 16-bit word (2 bytes). sizeof(char) and sizeof(short) return 1, which
corresponds to one 16-bit word. The rtIOStream function expects the byte order within the word to
be little-endian, that is, less significant bytes are transmitted before more significant bytes.
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rtiostreamtest identifies the target hardware and handles data in terms of 16-bit words, for
example, a byte value is transferred as a 16-bit word value.

See Also
rtIOStreamClose | rtIOStreamOpen | rtIOStreamRecv | rtIOStreamSend |
rtiostream_wrapper | rtiostreamtest |
rtw.connectivity.RtIOStreamHostCommunicator

Related Examples
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
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Specify Hardware Timer
For processor-in-the-loop (PIL) code execution profiling, you must create a timer object that provides
details of the hardware-specific timer and associated source files. You can use the Code
Replacement Tool or the code replacement library API to specify this hardware-specific timer.

To specify the timer with the Code Replacement Tool:

1 Open the Code Replacement Tool. In the Command Window, enter crtool.
2 Create a new code replacement table. Select File > New table.
3 Create a new function entry. Under Tables List, right-click the new table. Then, from the

context-menu, select New entry > Function.
4 In the middle view, select the new unnamed function.
5 On the Mapping Information pane:

a From the Function drop-down list, select code_profile_read_timer.
b Specify the count direction for your timer. For example, from the Count direction drop-

down list, select Up.
c In the Ticks per second field, specify the number of ticks per second for your timer, for

example, 1e+09.

The default value is 0. In this case, the software reports time measurements in terms of
ticks, not seconds.

d In the Conceptual function section, from the Data type list, select uint8, uint16,
uint32, or uint64.

e In the Function prototype section, in the Name field, specify a replacement function name,
for example, MyTimer.

f Click Apply.
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g To validate the function entry, click Validate entry.
6 On the Build Information pane, specify the required build information. See Specify build

information in “Define Code Replacement Library Optimizations” on page 67-36.
7 Save the table (Ctrl+S). When you save the table for the first time, use the Save As dialog box to

specify the file name and location.

You must save the table in a location that is on the MATLAB search path. For example, you can
save this file in the folder for your subclass of rtw.connectivity.Config.

The software stores your timer information as a code replacement library table.
8 Assuming you save the table as MyCrlTable.m, in your subclass of

rtw.connectivity.Config, add the following line:

setTimer(this, MyCrlTable)

See Also

Related Examples
• “Create a Target Connectivity API Implementation” on page 80-39
• “Code Execution Profiling with SIL and PIL” on page 74-2
• “Define Code Replacement Library Optimizations” on page 67-36

More About
• “What Is Code Replacement?” on page 55-2
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• “What Is Code Replacement Customization?” on page 67-3
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Set Up PIL Connectivity by Using target Package
Before you can run processor-in-the-loop (PIL) simulations, you must set up connectivity between
Simulink and your target hardware. The connectivity enables the PIL simulation to:

• Build the target application.
• Download, start, and stop the application on the target hardware.
• Support communication between Simulink and the target hardware.

Use one of these workflows.

Workflow When to use
target package with rtiostream API Use this workflow if your target application has

large I/O requirements that need high-bandwidth
communication.

For more information, see “Use rtiostream API
for PIL Target Connectivity” on page 80-49.

target package with debugger Use this workflow if:

• You want a single debugger integration to
provide PIL connectivity for target hardware
systems that are supported by the debugger.
This workflow requires little or no target-
specific code.

• The I/O requirements of the target application
are small. For example, unit tests on a
component. If you use this workflow for a
target application that has large I/O
requirements, the execution of the application
is slower.

For more information, see “Use Debugger for PIL
Target Connectivity” on page 80-52.

Use rtiostream API for PIL Target Connectivity
To provide PIL connectivity between Simulink and the target hardware, you can use the target
Package with the rtiostream API on page 80-43. In this example, your development computer is the
target hardware.

1 Create the board description

Create a target.Board object that provides MATLAB with a description of your target
hardware.
hostTarget = target.create('Board', ...
                           'Name', 'Example Intel Board');

To support code generation and data I/O in PIL simulations, associate the object with processor,
connection, and communication descriptions.
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2 Associate the board with a processor

To support code generation, associate the board with a target.Processor object that contains
a language implementation. For this example, create a target.Processor object and reuse an
existing target.LanguageImplementation object. For information about setting up a custom
target.LanguageImplementation object, see “Register New Hardware Devices” on page 9-
11.
processor = target.create('Processor', 'Name', 'ExampleProcessor');
processor.LanguageImplementations = target.get('LanguageImplementation', ...
                                               'Intel-x86-64 (Windows64)'); 

Associate the target.Board object with the new target.Processor object by using the
Processors property
hostTarget.Processors = processor;

3 Specify execution information for the target hardware

Create an object that contains details about executing the target application. The object
describes the tool that is required to run the target application on the target hardware. To
capture system commands for starting and stopping the target application, you can use the
HostProcessExecutionTool or SystemCommandExecutionTool class .
applicationExecution = target.create('HostProcessExecutionTool');
applicationExecution.Name = 'Windows Application';

Create a Command object for downloading and running the target application. Assign the string
variable '$(EXE)' to the String property as a place holder for the target application name,
which is not known until execution.
runCommand = target.create('Command');
runCommand.String = '$(EXE)';
applicationExecution.StartCommand = runCommand;
hostTarget.Tools.ExecutionTools = applicationExecution;

4 Create the communication interface for the target hardware

Create a CommunicationInterface object that provides the target hardware with details of
the communication channel and the rtiostream API on page 80-43 implementation.

Use:

• The shipped TCP/IP rtiostream implementation source file.
• A BuildDependencies object to specify, for the rtiostream API, the source files that are

compiled with the target application.
• A MainFunction object to pass arguments to the target application

comms = target.create('CommunicationInterface');
comms.Name = 'Windows TCP Interface';
comms.Channel = 'TCPChannel';
comms.APIImplementations = target.create('APIImplementation', ...
                                         'Name', 'x86 RTIOStream Implementation');
comms.APIImplementations.API = target.create('API', 'Name', 'RTIO Stream');
comms.APIImplementations.BuildDependencies = target.create('BuildDependencies');
comms.APIImplementations.BuildDependencies.SourceFiles = ...
                                           {fullfile('$(MATLABROOT)', ...
                                                     'toolbox', ...
                                                     'coder', ...
                                                     'rtiostream', ...
                                                     'src', ...
                                                     'rtiostreamtcpip', ...
                                                     'rtiostream_tcpip.c')};
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comms.APIImplementations.MainFunction = target.create('MainFunction', ...
                                                      'Name', 'TCP RtIOStream Main');
comms.APIImplementations.MainFunction.Arguments = {'-blocking', '1', '-port', '0'};
hostTarget.CommunicationInterfaces = comms;

5 Specify PIL protocol information

This step is optional. A PIL simulation uses a communication protocol for the transfer of data
between Simulink and the target hardware. The target.PILProtocol class describes the
parameters of the protocol. For this example, you can improve target run-time performance by
increasing the I/O buffer size that the protocol uses.

Create a target.PILProtocol object and specify I/O buffer size.
pilProtocol = target.create('PILProtocol');
pilProtocol.Name = 'Windows PIL Protocol';
pilProtocol.SendBufferSize = 50000;
pilProtocol.ReceiveBufferSize = 50000;
hostTarget.CommunicationProtocolStacks = pilProtocol;

If you do not perform this step, default target.PILProtocol values are used.
6 Add profiling timer

You can configure a PIL simulation to produce execution-time profiles for the generated code. To
support code execution profiling, you must create a timer object that describes the retrieval of
current time from generated code running on the target hardware. The timer object description
must include a description of the function that retrieves time and its implementation.

This example uses a C function, timestamp_x86, which returns the current time as a uint64
data type.
timerSignature = target.create('Function');
timerSignature.Name = 'timestamp_x86';
timerSignature.ReturnType = 'uint64';

Capture the function in an API object.
timerApi = target.create('API');
timerApi.Functions = timerSignature;
timerApi.Language = target.Language.C;
timerApi.Name = 'Windows Timer API';

Capture the dependencies of the function, that is, the source and header files that are required to
run the function.
timerDependencies = target.create('BuildDependencies');
timerDependencies.IncludeFiles = {'host_timer_x86.h'};
timerDependencies.IncludePaths = {'$(MATLAB_ROOT)/toolbox/coder/profile/src'};
timerDependencies.SourceFiles = {'host_timer_x86.c'};

Create an object that combines the API and dependencies.
timerImplementation = target.create('APIImplementation');
timerImplementation.API = timerApi;
timerImplementation.BuildDependencies = timerDependencies;
timerImplementation.Name = 'Windows Timer Implementation';

Create the timer object and associate it with the timer information.
timer = target.create('Timer');
timer.APIImplementation = timerImplementation; 
timer.Name = 'Windows Timer';

Assign the timer to the processor object.
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processor.Timers = timer;

7 Specify connection between development computer and target hardware

The previous steps created target hardware support for communications and running the target
application. Now, set up a connection between your development computer and the target
hardware by creating a TargetConnection object. Specify:

• The communication channel, which is the same channel specified in the target hardware
communication interface –– see step 4.

• The connection properties.
• The target, which is the board description specified in previous steps.

connection = target.create('TargetConnection');
connection.Name = 'Host Process Connection';
connection.Target = hostTarget;
connection.CommunicationChannel = target.create('TCPChannel');
connection.CommunicationChannel.Name = 'External Process TCPCommunicationChannel';
connection.CommunicationChannel.IPAddress = 'localhost';
connection.CommunicationChannel.Port = '0';

8 Make board and connection objects persist across MATLAB sessions

To register the connectivity in MATLAB, add the target hardware and connection information to
an internal database by using the target.add function. By default, the information is only
available for the current MATLAB session. To make the registration persist across MATLAB
sessions, specify the name-value pair 'UserInstall', true.
target.add([hostTarget connection], 'UserInstall', true);

9 Specify board for model

You can now specify your development computer as the target hardware for PIL simulations.
Before you run a PIL simulation, in the Configuration Parameters dialog box, set Hardware
board to Example Intel Board.

Use Debugger for PIL Target Connectivity
To provide PIL connectivity between Simulink and the target hardware, you can use the target
Package with a debugger, for example, the GNU Debugger.

1 Implement the target.DebugIOTool debugger abstraction interface

Implement the interface in a class called myImplementationClass. For an example
pseudocode implementation, see “DebugIOTool Template” on page 80-53.
classdef myImplementationClass < target.DebugIOTool
    properties (Access=private)
    …
    end
     
    methods
    …
    end

    methods (Access=private)          
    …
    end
end

2 Create the board description

Create target.Board object that provides MATLAB with a description of your target hardware.
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hostTarget = target.create('Board', ...
                           'Name', 'GDB Debug PIL IO');

3 Associate the board with a processor

To support code generation, associate the board with a target.Processor object that contains
a language implementation. For this example, create a target.Processor object and reuse an
existing target.LanguageImplementation object. For information about setting up a custom
target.LanguageImplementation object, see “Register New Hardware Devices” on page 9-
11.
hostTarget.Processors = target.get('Processor', ...
                                   'Intel-x86-64 (Linux 64)');

4 Describe the debugger execution service implementation

Create a target.ExecutionService object that references the debugger abstraction
interface.
matlabExecution = target.create('ExecutionService', ...
                                'Name', 'GDB Launch');
matlabExecution.APIImplementation = ...
                                target.create('APIImplementation', ...
                                'Name', 'myServiceImplementation');
matlabExecution.APIImplementation.BuildDependencies = ...
                                target.create('MATLABDependencies');
matlabExecution.APIImplementation.BuildDependencies.Classes = ...
                                {'myImplementationClass'};
matlabExecution.APIImplementation.API = ...
                                target.get('API', ...
                                'DebugIOTool');

5 Associate debugger execution service with the board

Associate the target.ExecutionService object with the target.Board object.
hostTarget.Tools.DebugTools = matlabExecution;

6 Make board object persist across MATLAB sessions

Add the board object to an internal database and make the object persist across MATLAB
sessions.
target.add(hostTarget, 'UserInstall', true);

7 Specify board for model

Before you run a PIL simulation, in the Configuration Parameters dialog box, set Hardware
board to GDB Debug PIL IO.

DebugIOTool Template
This section provides a pseudocode example of target.DebugIOTool debugger abstraction. Use a
target.DebugIOTool object to:

• Control the lifetime of an application running in the debugger.
• Automate common debugger actions. For example, applying breakpoints and continuing execution

from a paused state.
• Read and write to memory that the application uses.

For interactions with the debugger, you can use MATLAB external language interfaces to APIs, which
the debugger vendor supplies.
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target.DebugIOTool debugger abstraction example
classdef DebugIOToolTemplate < target.DebugIOTool
% DEBUGIOTOOLTEMPLATE Example implementation of target.DebugIOTool
% debugger abstraction.

%   Copyright 2020 The MathWorks, Inc.
    
    properties (Access=private)
        
        % Optional
        % Add any state required to interact with the debugger or
        % application being run in the debugger as a property of
        % DebugIOTool. Apply private access so that only this file 
        % can access the state.
        %
        % For example, the state could be a handle to the debugger
        % application provided by the debugger external API.
        DebuggerHandle;
    end   
    
    % Method implementations that perform debugger interactions.
    % Each method will return a 'withoutError' logical flag indicating 
    % whether the method executed withoutError. Consider also using the 
    % MATLAB error method to report custom error information.
    methods
                
        % Constructor for the target.DebugIOTool. The constructor
        % creates an instance of the tool allowing its methods to be called
        % on that instance. Optional.
        function this = DebugIOToolTemplate()
            
            % Basic initialization can be performed here. For example
            % setting state ready for calls to open
        end
        
        % Open the debugger. Optional.
        function withoutError = open(this)
            
            % Add logic here to open the debugger. Typically, use system
            % commands or the external API provided by the debugger.
            %
            % If you cannot open the debugger without also loading the
            % application into the debugger, this method should not be
            % implemented and the logic should be performed in the
            % 'loadApplication' method.
            %
            % If you cannot open the debugger without also starting
            % execution of the application, this method should not be
            % implemented and the logic should be performed in the
            % 'startApplication' method.
            
            this.DebuggerHandle = this.callExternalDebugger('open');
            withoutError = true;
        end
        
        % Load the application into the debugger. Optional.
        function withoutError = loadApplication(this)
            
            % Add logic here to load the application into the debugger.
            % This could be loading a project into an IDE debugger or
            % loading the application executable into the debugger harness.
            %
            % Additionally add logic to set breakpoints in the debugger to
            % break execution.
            %
            % The path to the application to load is stored in the
            % Application property of this class which can be accessed
            % using this.Application in this method.
            %
            % Additional command line arguments to pass to the the 
            % application are stored in 
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            % this.ApplicationCommandLineArguments.
            %
            % Breakpoints to set are stored in this.Breakpoints
            %            
            % If you cannot load the application without also starting
            % execution of the application, this method should not be
            % implemented and the logic should be performed in the
            % 'startApplication' method.
            
            this.callExternalDebugger('load application', ...
                                       this.Application, ....
                                       this.ApplicationCommandLineArguments);
            
            this.callExternalDebugger('set breakpoints', this.Breakpoints);
            
            withoutError = true;
        end
        
        % Start the application execution in the debugger. Required.
        function withoutError = startApplication(this)
            
            % Add logic here to start the application execution in the 
            % debugger.
            %
            % The path to the application to load is stored in the
            % Application property of this class which can be accessed
            % using this.Application in this method.
            %
            % Additional command line arguments to pass to the 
            % application are stored in 
            % this.ApplicationCommandLineArguments.
            %
            % Breakpoints to set are stored in this.Breakpoints
            
            this.callExternalDebugger('start application');
            
            withoutError = true;
        end
        
        % Stop the application execution in the debugger. Optional.
        function withoutError = stopApplication(this)
                        
            % Add logic here to stop the application execution in the 
            % debugger.
            
            % If your 'startApplication' method opened the debugger,
            % perform the opposite action here, i.e. close the 
            % debugger.
            %
            % If your 'startApplication' method loaded the application,
            % perform the opposite action here, i.e. unload the
            % application from the debugger.
            
            this.callExternalDebugger('stop application');
            
            withoutError = true;
        end
        
        % Unloads the application from the debugger. Optional.
        function withoutError = unloadApplication(this)
                        
            % If you implemented the 'loadApplication' method, 
            % then add logic here to unload the application from
            % the debugger.
            
            % If your 'loadApplication' method opened the debugger, 
            % perform the opposite action here, i.e. close the 
            % debugger.
            
            this.callExternalDebugger('unload application');
            
            withoutError = true;
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        end
        
        % Closes the debugger. Optional.
        function withoutError = close(this)
                        
            % Add logic here to close the debugger. If you implemented the 
            % 'open' method you should implement this method.
            
            this.callExternalDebugger('close');
            
            withoutError = true;
        end              
        
        % Asks if the debugger is currently stopped at the specified
        % breakpoint. Returns true if at the specified breakpoint, false
        % otherwise. Required.
        function [atBreakpoint, withoutError] = ...
                                    stoppedAtBreakpoint(this, breakpoint)
            
            % Add logic to determine if the debugger has broken execution
            % at the breakpoint passed into the function.
            %
            % The 'breakpoint' input variable is of type target.Breakpoint 
            % which provides the description of the breakpoint. It contains
            % properties Function, File and Line which describes the
            % location of the breakpoint.
            %
            % Set the atBreakpoint return value to true if the debugger is
            % stopped at the breakpoint, or false if not.
            
            result = this.callExternalDebugger('determine breakpoint hit', ...
                                                breakpoint.File, ...
                                                breakpoint.Line, ...
                                                breakpoint.Function);
            atBreakpoint = ~isempty(result);
            
            withoutError = true;
        end
        
        % Continues execution if application execution is paused in the 
        % debugger. Required.
        function withoutError = continueExecution(this)
            
            this.callExternalDebugger('continue execution');
            withoutError = true;
        end  
                
        % Write the specified memory stream to the target platform memory
        % specified by the given variable name.
        function withoutError = write(this, variableName, memoryStream)
            
            % Add logic to write the memoryStream data to the variableName
            % variable in the target. This function should assume that the
            % appropriate breakpoint has been hit to perform such an
            % action.
            %
            % memoryStream is a vector of uint64 values to be written to
            % the target platform. The unit64 values act as a container for
            % the smallest addressable integer on the target platform. In
            % most cases this will be a container for the size of char on
            % the target platform, which will commonly be 8-bit.
            %
            % The specified variable will represent a pointer to the
            % smallest addressable integer type.
            
            % As an example write operations on a target platform where 
            % char represents the smallest addressable integer should be 
            % equivilant to the following memcpy call in C code:
            %
            % (void*)memcpy(<variableName>, ...
                            (unsigned char[<sizeOfMemoryStream>]) ...
                            {<memoryStream(1)>,<memoryStream(2)>, ...}, ...
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                            <sizeOfMemoryStream>);
            %
            % A lot of debuggers allow for immediate execution of code when
            % execution is broken, if so, attempt to use the above command
            % to write data to the variable like the below example:
              
            sizeOfMemoryVariable = uint64(numel(memoryStream));
            arrayFormat = repmat('%d,', [1 sizeOfMemoryVariable]);
            arrayFormat(end) = [];
              
            this.callExternalDebugger(sprintf('execute (void*)memcpy(%s, ...
                                      (unsigned char [%d]){%s}, %d)', ...
                                      variableName, ...
                                      sizeOfMemoryVariable, ...
                                      sprintf(arrayFormat, memoryStream), ...
                                      sizeOfMemoryVariable));
                          
            withoutError = true;
        end
        
        % read the memory stream from the target platform memory specified 
        % by the given variable name.
        function [memoryStream, withoutError] = read(this, ...
                                                     variableName, ...
                                                     sizeToRead)            
            
            % Add logic to read from the variableName variable on the 
            % target. This function should assume that the appropriate 
            % breakpoint has been hit to perform such an action.
            %
            % The memoryStream return value should be a vector of uint64 
            % values. The unit64 values act as a container for the smallest 
            % addressable integer on the target platform. In most cases 
            % this will be a container for the size of char on the target 
            % platform, which will commonly be 8-bit.
            %
            % The specified variable will represent a pointer to the
            % smallest addressable integer type.
            
            % Read operations should be equivilant to inspecting the result
            % of the following C code:
            % (unsigned char [<sizeToRead>])*<variableName>
            %
            % A lot of debuggers allow for immediate execution of code when
            % execution is broken, if so, attempt to use the above command
            % to inspect the value of the buffer and return it to MATLAB.
                        
            memoryStream = this.callExternalDebugger(...
                           sprintf("read (unsigned char [%d])*%s", ...
                           sizeToRead, variableName));
            
            % The memory stream must be returned as a vector of uint64
            % values
            memoryStream = uint64(memoryStream);
            
            withoutError = true;
        end
    end
    
    methods (Access=private)
        
        function output = callExternalDebugger(~, varargin)
            
            output = [];
            fprintf("\nInstructed the debugger to '%s'\n", varargin{1});
            
            if nargin > 2
                disp('Using arguments:');
                disp(varargin(2:end));
            end
        end
    end
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end

See Also
target Package

More About
• “SIL and PIL Simulations” on page 80-2
• “Configure and Run PIL Simulation” on page 80-26
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Custom Toolchain Directives Required for Code Coverage and
Execution Profiling

If you use a custom toolchain for building a processor-in-the-loop (PIL) target application that
supports Simulink Coverage analysis or Embedded Coder code execution profiling, in the toolchain
definition file, you must provide these compiler directives:

• CompileFlag — Specify the flag that C or C++ compiler uses to compile source files without
linking. For example, if the compiler in the toolchain is GNU C or C++, set the directive to -c.

• PreprocessFile — Specify the flag that C or C++ compiler uses to preprocess the source files
without running other compiler stages. For example, if the compiler in the toolchain is GNU C or C
++, set the directive to -E.

This section from a toolchain definition file example shows how you can use the setDirective
method to provide the directives.

tc = coder.make.ToolchainInfo('BuildArtifact','nmake makefile');
tc.Name ='My Toolchain Name';
tc.Platform ='win64';
tc.SupportedVersion ='14';
...
% ------------------------------
% C Compiler
% ------------------------------
tool = tc.getBuildTool('C Compiler');
tool.setName('My C Compiler');
...
tool.setDirective('CompileFlag','-c');
tool.setDirective('PreprocessFile','-E');
...

See Also

More About
• “Custom Toolchain Registration”
• “Add Custom Toolchains to MATLAB® Coder™ Build Process”
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PIL Simulation Sequence
A processor-in-the-loop (PIL) simulation cross-compiles production source code, and then downloads
and runs object code on your target hardware. The connectivity configuration that you create controls
the way code is compiled and executed on the target. This table describes the sequence of stages in a
PIL simulation.

Stage Description
1 Start For top-model PIL, on the Simulink Editor toolbar, you select the

Processor-in-the-Loop (PIL) mode, and then click the Run
button.

For Model block PIL, you set the Simulation mode parameter of
the Model block to Processor-in-the-loop (PIL), and then
run a simulation of the harness model that contains the Model
block.

For the PIL block, you run a simulation of the harness model that
contains the PIL block.

2 Validate target connectivity The software verifies that a target connectivity configuration is
registered for PIL. Otherwise, the software produces an error.

3 Generate production
source code and build
object code for target

The generated source code is identical to the code that is produced
when you run the slbuild command.

• For top-model PIL or Model block PIL with block parameter
Code interface set to Top model, the generated code is
identical to the code produced when you run
slbuild('model').

• For Model block PIL with block parameter Code interface set to
Model reference, the generated code is identical to the code
produced when you run slbuild('model',
'ModelReferenceCoderTargetOnly').

The software builds object code for the target by using the template
makefile or toolchain that you specify.

4 Create instances of PIL API
components

The software instantiates your rtw.connectivity.Config class,
which creates instances of
rtw.connectivity.MakefileBuilder,
rtw.connectivity.Launcher,
rtw.pil.RtIOStreamApplicationFramework, and
rtw.connectivity.RtIOStreamHostCommunicator.

5 Generate PIL files The generated PIL files are in the pil folder. At the end of the
simulation, use the code generation report to view the files.
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Stage Description
6 Build target application The software:

• Uses your instance of rtw.connectivity.MakefileBuilder
to build the target application.

• Compiles the PIL interface file, xil_interface.c, and other
PIL files into the target executable file. On a Windows system,
for example, this file is called modelName.exe. The object code,
including the executable file, is in the pil folder.

• If configured, produces the code generation report.
7 Start target application The software uses rtw.connectivity.Launcher to start the

application on the target.
8 Simulink engine interacts

with PIL S-function
The Simulink engine interacts with the PIL S-function in the same
way that it interacts with a C S-function.

From the host-side, the PIL S-function communicates with the
target executable code through rtIOStream commands. On the
target side, xil_interface executes generated code.

9 Stop target application The software uses rtw.connectivity.Launcher to stop the
application on the target.

10 End PIL simulation For top-model PIL, at the end of the simulation, the software
destroys the rtw.connectivity.Config instance.

For Model block PIL and PIL block, the block creates and owns the
rtw.connectivity.Config instance, which is not destroyed at
the end of the simulation. You can rerun the simulation, which now
does not require the creation of another
rtw.connectivity.Config instance. If you want to destroy the
instance, close the parent model.

See Also
rtw.connectivity.Config | rtw.connectivity.Launcher |
rtw.connectivity.MakefileBuilder | rtw.connectivity.RtIOStreamHostCommunicator |
rtw.pil.RtIOStreamApplicationFramework

Related Examples
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “View SIL and PIL Files in Code Generation Report” on page 80-65

More About
• “SIL and PIL Simulations” on page 80-2
• “Simulink Engine Interaction with C S-Functions”

 PIL Simulation Sequence

80-61



Verification of Code Generation Assumptions
At the start of a software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation, the software
verifies some configuration parameter settings with reference to the target hardware.

For example, in the Configuration Parameters dialog box, the Hardware Implementationsettings
specify target behavior, which result in the implementation of implicit assumptions in the generated
code. Incorrect settings can lead to:

• Suboptimal code
• Code execution failure, incorrect code output, and nondeterministic code behavior

The software checks:

• The correctness of settings. For example, the integer bit length in the Number of bits: int field.
• Whether the settings are optimized. For example, the rounding of signed integer division in the

Signed integer division rounds to field.

The simulation generates a Coder Assumptions page on page 56-13 for the code generation report,
which provides a list of:

• Code generation assumptions that are checked
• Expected results for the assumption checks

This table shows when checks occur and outcomes when code generation assumptions are incorrect.

Stage What is Checked Outcome
Preprocessor Number of bits per:

• char (ProdBitPerChar)
• short (ProdBitPerShort)
• int (ProdBitPerInt)
• long (ProdBitPerLong)

If Support long long
(ProdLongLongMode) is
selected, number of bits per
long long

For each data type, the
preprocessor check is not
performed if the number of bits
exceeds these settings for the
target C preprocessor:

• For signed integer math,
TargetPreprocMaxBitsSi
nt.

• For unsigned integer math,
TargetPreprocMaxBitsUi
nt.

Error if data type sizes for
model and target hardware do
not match.
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Stage What is Checked Outcome
Run-time Number of bits per:

• char (ProdBitPerChar)
• short (ProdBitPerShort)
• int (ProdBitPerInt)
• long (ProdBitPerLong)

Error if data type sizes for
model and target hardware do
not match.

If Support long long
(ProdLongLongMode) is
selected, number of bits per
long long

Error if:

• Target hardware does not
support long long.

• Data type sizes for model
and target hardware do not
match.

Size of:

• float
• double

You cannot configure these data
type sizes through the
Hardware Implementation
pane. The check is performed
only if Support: floating-point
numbers is selected.

Warning if data type sizes for
model and target hardware do
not match.

For double, warning is
generated if size of target
hardware data type is not 32 or
64 bits.

Number of bits per:

• pointer
(ProdBitPerPointer)

• size_t (ProdBitPerSizeT)
• ptrdiff_t

(ProdBitPerPtrDiffT)

Error if data type sizes for
model and target hardware do
not match.

Signed integer division
rounds to
(ProdIntDivRoundTo) setting

Warning if model parameter
setting is Undefined.

Error if target hardware
behavior is undefined and model
parameter setting is not
Undefined.

Error if target hardware
behavior is defined but settings
for model and target hardware
do not match.

Byte ordering
(ProdEndianess) setting

Warning if setting is
Unspecified. Otherwise, error
if settings for model and target
hardware do not match.
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Stage What is Checked Outcome
Shift right on a signed
integer as arithmetic shift
(ProdShiftRightIntArith)
setting

Error if settings for model and
target hardware do not match.

Remove root level I/O zero
initialization
(ZeroExternalMemoryAtStar
tup) setting

Warning if
ZeroExternalMemoryAtStar
tup is 'off' and initial values
of global variables in the target
application are not zero.

Remove internal data zero
initialization
(ZeroInternalMemoryAtStar
tup) setting

Warning if
ZeroInternalMemoryAtStar
tup is 'off' and initial values
of global variables in the target
application are not zero.

Use dynamic memory
allocation for model
initialization
(GenerateAllocFcn) setting

Warning if GenerateAllocFcn
is 'on' and initial values of
dynamically allocated memory
in the target application are not
zero.

Simulation behavior for
denormal numbers
(DenormalBehavior) setting

Error if behavior for model and
target hardware does not
match.

See Also
“Hardware Implementation Pane”

More About
• “SIL and PIL Simulations” on page 80-2
• “Check Code Generation Assumptions” on page 56-12
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View SIL and PIL Files in Code Generation Report
With top-model and Model block SIL and PIL simulations, you can produce a code generation report
and static code metrics that cover SIL and PIL files. The information helps you to:

• Understand and review the SIL and PIL testing process.
• See how your registered custom target connectivity files fit into the target application that runs

during a SIL or PIL simulation.

This capability is not supported for simulations that you run with the PIL block.

To configure the creation of a code generation report and static code metrics, in the Configuration
Parameters dialog box, select the Create code generation report, Open report automatically,
and Generate static code metrics check boxes. Then click OK.

At the end of the simulation, in the Code Generation Report window:

• To review code metrics, in the Contents view, click Static Code Metrics Report.
• To review SIL and PIL files, in the Generated Code view, expand the SIL/PIL files node. For

example:

• To review the S-function that runs on the host, click modelName_sbs.c or
modelName_pbs.c.

• To view the SIL or PIL interface that runs on the target, click xil_interface.c.
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Note Do not use the SIL or PIL files in code development as these files can change over releases.
Use supplied APIs for code development.

See Also

Related Examples
• “Static Code Metrics” on page 52-23

More About
• “HTML Code Generation Report Extensions” on page 52-3
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SIL/PIL Manager Verification Workflow
The SIL/PIL Manager is an app that provides a simplified workflow for verifying generated model
code.

Open the App
To open the SIL/PIL Manager in the Simulink Editor, on the Apps tab, click SIL/PIL Manager. Or, on
the C Code tab in the Embedded Coder app, select Verify Code > SIL/PIL Manager.

Select the Mode
In the Mode section, specify the simulations that you want the app to run. You can select:

• Automated Verification –– The app runs two simulations back-to-back. The first simulation is a
model simulation in normal, accelerator, or rapid accelerator mode. The second simulation is a
software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation. After the second simulation is
complete, the app uses the Simulation Data Inspector to compare the results of the simulations.

For the first simulation, if the model contains a Model block with the Simulation mode block
parameter set to Software-in-the-loop (SIL) or Processor-in-the-loop (PIL), at the
start of the simulation, the app changes the block parameter to Normal. At the end of the
simulation, the app reverts the block parameter to the previous value.

• Simulation Only –– The app runs a model simulation in normal, accelerator, or rapid accelerator
mode.

If the model contains a Model block with the Simulation mode block parameter set to
Software-in-the-loop (SIL) or Processor-in-the-loop (PIL), at the start of the
simulation, the app changes the block parameter to Normal. At the end of the simulation, the app
reverts the block parameter to the previous value.

• SIL/PIL Simulation Only –– The app runs a SIL or PIL simulation.

Prepare the Model
In the Prepare section:

• Specify the numeric testing approach.
• Specify the main configuration parameters.
• Enable or disable code execution profiling and code coverage analysis.

This table shows how the field settings in the Prepare section control simulations that the app runs.
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Workflow Field Settings Model Simulation SIL or PIL Simulation
Top model System Under Test —

Top model

Simulation Mode —
Normal, Accelerator,
or Rapid
Accelerator

SIL/PIL Mode —
Software-in-the-
Loop (SIL) or
Processor-in-the-
Loop (PIL)

Top model simulation
mode specified by
Simulation Mode
setting.

Model blocks in SIL or
PIL mode are set to
normal mode.

Top model simulation
mode specified by
SIL/PIL Mode setting.

Model blocks use
specified simulation
modes.

Model block System Under Test —
Model blocks in SIL/PIL
mode

Top Model Mode —
Normal or
Accelerator

Top model simulation
mode specified by Top
Model Mode setting.

Model blocks in SIL or
PIL mode are set to
normal mode.

Top model simulation
mode specified by Top
Model Mode setting.

Model blocks use
specified simulation
modes.

Test harness

The app supports test
harnesses that you
create from models and
Model blocks. For
information about
creating test harnesses,
see “Create Test
Harnesses and Select
Properties” (Simulink
Test).

System Under Test —
Harness owner. Not
editable.

Simulation Mode —
Normal, Accelerator,
or Rapid
Accelerator

SIL/PIL Mode —
Software-in-the-
Loop (SIL) or
Processor-in-the-
Loop (PIL)

Harness model in
normal mode.

Model block mode for
harness owner specified
by Simulation Mode
setting.

Internal Model blocks of
harness owner in SIL or
PIL mode set to normal
mode.

Harness model in
normal mode.

Model block for harness
owner specified by
SIL/PIL Mode setting.

Internal Model blocks of
harness owner use
specified simulation
modes.

If you click Settings, the app provides these controls:

• Under SIL/PIL Settings:

• Settings — Display Verification parameters in the Configuration Parameters dialog box.
• Portable Word Sizes — Select or clear Enable portable word sizes. For information about

how you can generate code that supports compilation on your development computer, see
“Configure Hardware Implementation Settings” on page 80-20.

• SIL Debugging — Select or clear Enable source-level debugging for SIL.
• Under Coverage:

• Coverage Settings — Display Coverage parameters in the Configuration Parameters dialog
box.
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• Coverage Collection — Enable or disable code coverage. If code coverage with Simulink
Coverage is enabled, clicking the button toggles CovEnable between 'on' and 'off'. For
more information, see “Code Coverage”.

• Under Profiling:

• Task Profiling — Select or clear Measure task execution time.
• Save Options — If Task Profiling is selected, clicking the button sets the Save options
configuration parameter to Summary data only, All data, and Metrics only cyclically. If
Task Profiling is not selected, the button is dimmed.

• Functions — Clicking the button sets the Measure function execution times configuration
parameter to Off, Coarse (referenced models and subsystems only), and Detailed
(all function call sites) cyclically.

For more information, see “Configure Code Execution Profiling” on page 74-2 and “Control
Profiling Granularity” on page 74-3.

If you click Monitor Signals, the app provides these controls:

• Under Monitor Signals:

• Log Selected Signals — Enable signal logging for model simulation.
• Make Selected Signals Testpoints — Required for signal observation in SIL or PIL

simulations.
• Under Logging Options:

• Signal Logging — Set the SignalLogging configuration parameter to 'on' or 'off', which
enables or disables signal logging to the MATLAB workspace and signal streaming to the
Simulation Data Inspector.

• State Logging — Set the SaveState configuration parameter to 'on' or 'off', which
enables or disables state data logging to the MATLAB workspace and state data streaming to
the Simulation Data Inspector.

• Signal Table — Display the Signals tab in the Model Data Editor.
• Configure Logging — Display the Data Import/Export parameters in the Configuration

Parameters dialog box.
• Normal Mode Visibility — Open the Model Block Normal Mode Visibility dialog box.

To monitor component signals and state data and compare values from the model and SIL or PIL
simulations:

1 For each signal that you want to log:

a In the Simulink Editor, select the signal.
b On the SIL/PIL tab, click Monitor Signals. From the gallery, select these options:

• Log Selected Signals
• Make Selected Signals Testpoints
• Signal Logging

2 To log state data, from the Monitor Signals gallery, select State Logging.
3 If the Language configuration parameter is C++, in the Code Mappings editor, set the Data

Visibility for the signals, states, and internal data model element categories to public.
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For more information, see “Log Signals of a Component” on page 80-31.

Run Automated Verification, Model Simulation, or SIL/PIL Simulation
With one click, you can run back-to-back model and SIL or PIL simulations. You can also run
individual simulations.

If you select the Automated Verification mode, the SIL/PIL tab displays the Run Automated
Verification section. To run back-to-back simulations:

1 In the Stop Time field, specify the simulation time. For the Automated Verification mode, you
cannot specify inf.

2 Click Run Verification.

If you select the Simulation Only or SIL/PIL Simulation Only mode, the SIL/PIL tab displays the
Run section. In this case, the toolstrip provides additional controls:

• Fast Restart — Click to turn on fast restart. For the Simulation Only mode, the compiled model
does not contain components in SIL or PIL mode.

• Step Back and Step Forward — You can configure stepping through a simulation by using the
Simulation Stepping Options dialog box. To open the dialog box, click Step Back, and then select
Configure simulation stepping.

Simulation stepping is not available if the mode is SIL/PIL Simulation Only and System Under
Test is Top model.

To run an individual simulation:

1 In the Stop Time field, specify the simulation time.
2 Click Run Simulation or Run SIL/PIL.

Analyze Results and Export Test Cases
In the app Results section, you can analyze results. If you click Compare Runs or Data Inspector,
the app provides these controls in the Results gallery.

Section Control Description
Numerical
Equivalence
Results

Compare Runs Compare results from the last model and SIL/PIL
simulations by using the Simulation Data Inspector. Use
the comparison to decide whether the results are
numerically consistent.

If the mode is Automated Verification, at the end of
back-to-back simulations, the Simulation Data Inspector
compares logged signals from the model and SIL or PIL
simulations.

Data Inspector Open the Simulation Data Inspector.
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Section Control Description
Code Code View By default, at the end of SIL or PIL simulations, the

SIL/PIL Manager displays the Code view, which enables
you to:

• Analyze generated code.
• See code metrics.
• Trace between model elements and generated code.

If the view is closed and you want to reopen it, click Code
View.

Execution Profiling
Results

Highlight
Profiling

Highlight blocks profiled in the last SIL or PIL simulation.

Generate Report Open code execution profiling report for the last SIL or PIL
simulation. For more information, see “View and Compare
Code Execution Times” on page 74-6.

Generate
Schedule

In the Simulation Data Inspector, show task scheduling for
the last SIL or PIL simulation. For more information, see
“Visualize Task Scheduling”.

Coverage Analysis
Results

(Controls available
only if you have a
Simulink Coverage
license)

Coverage
Highlighting

Highlight blocks that are analyzed for coverage and
provide summary results.

Coverage
Details

Display the code coverage report in the Simulink Editor.

Results Explorer Open Results Explorer. For more information, see “Access,
Manage, and Accumulate Coverage Results by Using the
Results Explorer” (Simulink Coverage).

Generate Report Generate the code coverage report in a web browser.
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Section Control Description
Simulink Test Export to Test

Manager
If you have Simulink Test, using the current app settings,
you can create and export an equivalence test case. The
test case enables you to run to back-to-back simulations
and check whether model components and the generated
code are numerically equivalent.

1 Click Export to Test Manager.
2 In the Export SIL/PIL Test Cases dialog box:

a Click Use a new test file or Reuse an existing
file.

b In the Test file field, specify the name of the test
file. By default, the dialog box specifies:

currentWorkingFolderPath\modelName_Testfile.mldatx

If the test file exists and you click Use a new test
file, the app overwrites the existing file. If you
click Reuse an existing file, the app adds the
test case to the existing file.

3 Click OK. The app creates an equivalence test case in
the specified test file.

For information about using exported test cases, see
“Import Test Cases for Equivalence Testing” (Simulink
Test).

See Also
SIL/PIL Manager

More About
• “Choose a SIL or PIL Approach” on page 80-11
• “Code Coverage”
• “Code Execution Profiling”
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Security for PIL Simulations
Ensure that access to your development computer and the target hardware is secure.

Provide a secure communication channel between your development computer and the target
application by applying the security measures listed in this table.

Communication Protocol Security Measure
TCP/IP Run your development computer and target

application within a trusted private network or
virtual private network (VPN).

Serial Use a point-to-point link between your
development computer and target application, for
example, a serial cable.
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SIL and PIL Limitations

In this section...
“About SIL and PIL Limitations” on page 80-74
“General SIL and PIL Limitations” on page 80-74
“Top-Model SIL/PIL Limitations” on page 80-81
“Model Block SIL/PIL Limitations” on page 80-82
“Subsystem Block SIL/PIL Limitations” on page 80-83

About SIL and PIL Limitations
With Embedded Coder, you can run software-in-the-loop (SIL) and processor-in-the-loop (PIL)
simulations by using:

• The top-model.
• Model blocks.
• Blocks from subsystems.

The following sections describe modeling and code generation features that are either unsupported
or partially supported by SIL and PIL simulations.

General SIL and PIL Limitations
Tunable Parameters and SIL/PIL

For Model block SIL/PIL and SIL/PIL block simulations, you can tune tunable workspace parameters
but not tunable dialog box parameters. For information about tuning parameters, see “Tune and
Experiment with Block Parameter Values”.

For a top model with tunable parameters, you can run a SIL/PIL simulation but you cannot tune the
parameters during the simulation.

The software cannot define, initialize, or tune the following types of tunable workspace parameters.

Parameter description Software response
Top-Model SIL/PIL Model Block SIL/PIL SIL/PIL Block

Parameters with storage class
that applies "static" scope or
"const" keyword. For example,
Custom, Const, or
ConstVolatile

Warning Warning Warning

Parameters with multiword,
fixed-point data types

Warning Error Warning

Parameters with data types that
have different sizes on host and
target

Warning Error Warning
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For C++ class code, SIL/PIL you can tune tunable workspace parameters when Parameter visibility
is public. If Parameter visibility is private or protected, tuning is supported only if Parameter
access is Method or Inlined method.

For top-model SIL/PIL and the SIL/PIL block, consider the case where all of the following conditions
apply:

• Code Generation > Interface > Code interface packaging is Reusable function.
• Code Generation > Interface > Use dynamic memory allocation for model initialization is

not selected.
• Optimization > Default parameter behavior is Tunable.
• In the Code Mapping Editor for the model, the default storage class for the Global parameters or

Local parameters category is set to Default, and the model contains corresponding parameters
that use the storage classes Auto or Model default.

If the SIL/PIL component cannot dynamically initialize tunable parameters in the rtP model
parameter structure, you see an error message like the following:
Parameter Dialog:InitialOutput in 'rtwdemo_sil_topmodel/CounterTypeA/count'
is part of the imported "rtP" structure in the generated code but cannot be
initialized by SIL or PIL. To avoid this error, make sure the parameter 
corresponds to a tunable workspace variable. Alternatively, set 
"Configuration Parameters > Code Generation > Interface > Code interface packaging" 
to ''Nonreusable function'', or search for ''Use dynamic memory allocation 
for model initialization'' in the Configuration Parameters dialog box 
and select the checkbox.

If you select Code Generation > Interface > Use dynamic memory allocation for model
initialization, this limitation does not apply.

For Model block SIL/PIL, if you specify Code interface to be Top model, you can tune parameters
while a simulation runs. If you tune parameters between successive runs of the simulation, the
software generates new code for the later run. The new code uses your latest settings as initial
parameter values.

For top model or Model block SIL/PIL, if you change the value of a MATLAB variable or parameter
object (such as Simulink.Parameter) that you store in a workspace, Simulink Coder regenerates
the C code.

Model block SIL/PIL does not support test harness data definition, dynamic initialization, or tuning of
model workspace parameters.

Global and Local Data Stores

SIL/PIL supports global data stores. For components that are not export-function models, SIL/PIL
block simulations that access global data stores must be single rate. Otherwise, the software
produces an error.

SIL/PIL does not support local data stores.

Model block SIL/PIL does not support local Data Store Memory blocks that have these parameter
settings:

• Share across model instances – Selected.
• Storage class – Auto or Model default.
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You cannot create SIL/PIL blocks from models that use local Data Store Memory blocks with the
Share across model instances parameter selected.

SIL/PIL Does Not Check Simulink Coder Error Status

SIL/PIL does not check the Simulink Coder error status of the generated code under test. This error
status flags exceptional conditions during execution of the generated code.

Blocks in the model can also set the Simulink Coder error status, for example, custom blocks that you
create. SIL/PIL does not check this error status and report errors.

Missing Code Interface Description File Errors

SIL/PIL requires a code interface description file, which is created during code generation for the
component under test. If the code interface description file is missing, the SIL/PIL simulation cannot
proceed. You see an error reporting that the file does not exist. If you select the unsupported option
Classic call interface, this error can occur. Therefore, do not select the option.

To Workspace Block

If you enable MAT-file logging, top-model SIL/PIL and SIL/PIL blocks support To Workspace blocks.

Model block SIL/PIL does not support To Workspace blocks.

Cannot Connect SIL/PIL Outputs to Merge Block

If you connect Model block SIL/PIL or SIL/PIL block outputs to a Merge block, you see an error
because S-function memory is not reusable.

Unsupported Blocks

SIL/PIL does not support the following blocks:

• Scope blocks, and all types of run-time display. For example, display of port values and signal
values.

• Stop blocks. SIL/PIL ignores the Stop Simulation block and continues simulating.

Multiword Fixed-Point I/O

You cannot run SIL and PIL simulations of models that have multiword, fixed-point signals across
component boundaries.

Fixed-Point Data Types Wider Than 32 Bits

SIL/PIL supports fixed-point data types that are wider than 32 bits. For example:

• 64-bit long and long long
• 64-bit execution profiling timer data type
• int64 and uint64 in MATLAB Coder SIL execution.

The following constraints apply:

• For 64-bit data type support, the data type must be representable as long or long long on the
MATLAB host and the target. Otherwise, the software uses the multiword, fixed-point approach,
which SIL/PIL does not support.
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• The software does not support the 40-bit long data type of the TI’s C6000™ target.

Through the Configuration > Hardware Implementation pane, you can enable support for the
64-bit long long data type. For data types with widths between 33 and 40 bits (inclusive), the
software implements the data types using the 40-bit long data type, which SIL/PIL does not
support.

Data Type Replacement

The software does not support replacement data type names that you define for the built-in data type
boolean if these names map to the int or uint built-in data type.

Continuous Sample Times

Top-model SIL/PIL and SIL/PIL block do not support continuous sample times at the SIL or PIL
component boundary. However, they support continuous sample times within the component.

Model block SIL/PIL does not support continuous sample times.

Variable-Size Signals

Model block SIL/PIL simulations support variable-size signals only if Diagnostics > Model
Referencing > Propagate sizes of variable-size signals is During execution.

Top-model SIL/PIL and SIL/PIL block simulations treat variable-size signals at the I/O boundary of the
SIL/PIL component as fixed-size signals, which can lead to errors during propagation of signal sizes.
To avoid such errors, use only fixed-size signals at the I/O boundary of the SIL/PIL component.

There can be cases where no error occurs during propagation of signal sizes. In these cases, the
software treats variable-size input signals as zero-size signals.

Internal Signal Logging

SIL/PIL blocks do not support signal logging. For a workaround, see “Log Signals of a Component” on
page 80-22.

The following internal signal logging limitations apply to top-model and Model block SIL/PIL
simulations.

Limitation Applies To
Top-Model
SIL/PIL

Model Block
SIL/PIL

Signals feeding merge blocks are not supported for logging in
normal simulation but are logged in SIL/PIL mode. The logged values
during SIL/PIL are the same as the logged values for the output of
the merge block.

Yes No
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Limitation Applies To
Top-Model
SIL/PIL

Model Block
SIL/PIL

Top-model normal simulation logs data at a periodic rate but top-
model SIL/PIL simulation logs data at a constant rate under these
circumstances:

• Default parameter behavior is Tunable.
• A constant sample time signal from a Model block is logged in the

top model.
• The logged signal is not directly connected to a root-level output

port.

To avoid this behavior and log at the constant rate in all simulation
modes, set Default parameter behavior to Inlined.

Yes No

Features not supported:

• Signal logging in models referenced by the SIL/PIL component.
• Signal logging in Simulink Function block.
• Virtual signals.
• Buses.
• Frame-based signals, which are logged as sample-based signals.
• Continuous, asynchronous, and triggered sample times. At the

top-level of export-function models, you can log signals with
triggered sample times.

• Logging of Stateflow states and local data.

Yes Yes

Variable-size, function-call, and Action signals are not supported. A
normal simulation produces an error. A SIL/PIL simulation produces
a warning.

Yes No

State port signals are not supported. A normal simulation produces
an error. A SIL/PIL simulation does not produce a warning.

Yes No

Custom Storage Class of Type Other

SIL/PIL simulations support the custom storage class where Type is set to Other on page 80-7. These
limitations apply:

• If the code fragments returned by the TLC file associated with the custom storage class are
incomplete, the SIL/PIL application might fail to compile, or produce incorrect results.

• Custom storage classes with Imported scope and Pointer access are supported, but you must
provide code to initialize the pointer. For example, you can modify the response to
DataAccess(record, "define", "", "") to provide a definition of the storage
implementation, and initialize the pointer to the address of the implementation variable.

• To determine whether a variable is const and therefore not tunable, the build process for the
SIL/PIL application uses the memory section definition in the custom storage class. If the custom
storage class defines a variable as const and is not associated with a const memory section, the
target application might fail to compile, or produce an error during the simulation. In this case,
associate the custom storage class with a memory section for which Is const is specified, for
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example, MemConst. Alternatively, if SupportSILPIL is an instance-specific parameter in the
custom attributes class, for the associated signal or parameter, set
CoderInfo.CustomAttributes.SupportSILPIL to false.

Unsupported Implementation Errors

If you use a data store, signal, or parameter implementation that SIL/PIL does not support, you can
see errors like the following:
The following data interfaces have
implementations that are not supported by SIL or PIL.

data interfaces can be global data stores, inports, outports, or parameters.

The model output port has been optimized through virtual output port optimization. See “Virtualized
Output Ports Optimization” on page 71-15. The error occurs because the properties (for example,
data type, dimensions) of the signal or signals entering the virtual root output port have been
modified by routing the signals in one of the following ways:

• Through a Mux block.
• Through a block that changes the signal data type. To check the consistency of data types in the

model, display Port Data Types.
• Through a block that changes the signal dimensions. To check the consistency of data types in the

model, display Signal Dimensions.

Hardware Implementation

PIL does not support multiword data types where the word order differs from the target byte order.
The PIL simulation fails, displaying undefined behavior.

PIL requires that you configure the correct Hardware Implementation settings for the target
environment, including byte ordering for targets. If you do not specify the correct byte ordering, the
PIL simulation fails, displaying undefined behavior.

Bus Elements Mapped to Imported Bit-Field Definitions

If you map Simulink bus elements to bit fields through an imported header file, a SIL or PIL
simulation produces a build error. For example, if your model has an Inport block connected to a bus
that is a Simulink.Bus object with these properties:

• Name — myBus
• Bus elements — An array of Simulink.BusElement objects with these properties.

Name DataType Complexity Dimensions
bitField0 boolean real 1
bitField1 boolean real 1
bitField2 boolean real 1
bitField3 boolean real 1
bitField4 boolean real 1
bitField5 boolean real 1

• Data scope — Imported

 SIL and PIL Limitations

80-79



• Header file — busSpecification.h. This file contains myBus, which defines C bit-field data
types for the bus elements.

typedef struct myBus 
{
   unsigned int bitField0 : 1;
   unsigned int bitField1 : 1;
   unsigned int bitField2 : 1;
   unsigned int bitField3 : 1;
   unsigned int bitField4 : 1;
   unsigned int bitField5 : 1;
} myBus;

Size Mismatch Between Simulink and Target Hardware Data Types

When a Simulink data type and the corresponding target hardware data type differ in size, a SIL or
PIL simulation produces an error. This size mismatch can occur if you map a Simulink data type to the
target hardware data type through definitions in an imported header file. For example, if you create a
data type alias, T_BOOL, which is a Simulink.AliasType object with these properties:

• Base type — boolean.
• Mode — Built in, boolean.
• Data scope — Imported.
• Header file — myDefinitions.h. This file defines T_BOOL as an enumerated data type:

typedef enum _BOOL_TYPE
{
  FALSE           = 0,
  TRUE            = 1
} BOOL_TYPE;

typedef BOOL_TYPE T_BOOL;

In this case, the compiler for the target hardware determines the size of T_BOOL, which can differ
from the size of the Simulink data type, boolean.

SIL Simulations with Target-Specific Custom Code

Target-specific custom code that is not portable for execution on your development computer can
produce compilation or run-time failures during a SIL simulation.

For example, SIL does not support the use of custom code that explicitly casts pointers to integer-
type variables that are smaller than the length of a pointer variable on your development computer.
Consider using one of these alternatives:

• Run a PIL simulation.
• If you have custom code that casts pointers to a 32-bit integer type, for your development

computer, set up a PIL target connectivity configuration that uses a toolchain that is configured to
build a 32-bit binary application.

Sample Time Differences in Simulation Data Inspector Comparisons

If you use the Simulation Data Inspector to compare logged model outputs from normal and SIL or
PIL simulations, the sample times of the outputs might differ. You can still use the Simulation Data
Inspector to verify that the outputs match numerically.
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Top-Model SIL/PIL Limitations
Top-Model Root-Level Logging

Top-model SIL/PIL supports signal logging for signals connected to root-level inports and outports.
The C API is not required. Root-level logging has the following limitations:

• The characteristics of the logged data such as data type, sample time, and dimensions must match
the characteristics of the root-level inports and outports (rather than the characteristics of the
connected signal).

In some cases, there can be differences in data type and dimensions between the signal being
logged and the root inport or outport that the signal is connected to. Consider the following
examples.

• If a signal being logged has matrix dimensions [1x5] but the outport connected to the signal
has vector dimensions (5), then the data logged during a SIL or PIL simulation has vector
dimensions (5).

• If a signal being logged has scalar dimensions but the outport connected to the signal has
matrix dimensions [1x1], then the data logged during a SIL or PIL simulation has matrix
dimensions [1x1].

• Signals connected to duplicated inports are not logged during SIL/PIL simulation. No warning is
issued.

During normal simulation, signals connected directly to duplicated inports are logged.
• The Signal Logging Selector / DataLoggingOverride override mechanism is not supported.
• Normal and SIL/PIL simulations log bus signals with names that are different when all of the

following conditions apply:

• The SaveOutput or SignalLogging configuration parameter is on.
• The names of the elements in the bus signal are different from the corresponding names in the

bus object. For example, when the InheritFromInputs parameter for a Bus Creator block is
set to 'on'.

• The software inserts the suffix _wrapper for output logging if the save format is Structure or
Structure with time and you run the sim command without specifying the single-output
format. The software adds _wrapper to the block name for signals in yout. If the save format is
Array, the software does not add the suffix. For example:

>> yout.signals

ans =
        values: [11x1 double]
    dimensions: 1
         label: 'SignalLogging'
     blockName: 'sillogging_wrapper/OutputLogging'

To avoid this behavior, run command-line simulations with the sim command specifying the single-
output format. See “Run Simulations Programmatically”.

Callback Support

SIL/PIL does not support the callbacks (model or block) StartFcn and StopFcn.
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Note Top-model SIL/PIL supports the callback InitFcn.

Incremental Build

When you start a top-model SIL/PIL simulation, the software regenerates code if it detects changes to
your model. The software detects changes by using a checksum for the model. The software does not
detect changes that you make to:

• The HeaderFile property of a Simulink.AliasType object
• Legacy S-functions

If you make these changes, build (Ctrl-B) your model again before starting the next PIL simulation.

Model Block SIL/PIL Limitations
Top-Model Code Testing

The following limitations apply:

• Because model arguments do not apply to a top model, when the Code interface block parameter
is set to Top model, the software does not support the Model arguments block parameter.

• Conditional execution does not apply to a top model. If a Model block is set up to execute
conditionally and the Code interface block parameter is set to 'Top model', the software
produces an error when you run a SIL or PIL simulation.

• For sample time independent models, you must set Configuration Parameters > Solver >
Periodic sample time constraint to Ensure sample time independent.

Conditionally Executed Subsystem

You see an error if:

• You place your Model block, in either SIL or PIL simulation mode, in a conditionally executed
subsystem and the referenced model is multirate (that is, has multiple sample times). Single-rate,
referenced models (with only a single sample time) are not affected.

• Your Model block, in either SIL or PIL simulation mode, has blocks that depend on absolute time
and is conditionally executed.

Outputs with Constant Sample Time

If the block parameter Code interface is Top model, Model block SIL/PIL supports outputs with
constant sample time.

Noninlined S-Functions

Model-block SIL/PIL simulations do not support noninlined S-functions.

Referenced Models That Use Same Target Connectivity Configuration

Consider a top model with two or more Model blocks that reference models that use the same target
connectivity configuration. If the Model blocks are in PIL mode simultaneously, you cannot run a
simulation of the top model. An error occurs.
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SIL and PIL Instances of a Referenced Model

Consider a top model that contains two instances of a Model block that reference the same model. If
one instance is in SIL mode and the other instance is in PIL mode, you cannot run a simulation of the
top model. An error occurs.

Subsystem Block SIL/PIL Limitations
Atomic Subsystem Workflow Limitations

The workflow described in “Test Atomic Subsystem Generated Code” on page 80-18 does not support:

• These subsystem types:

• Virtual
• Function-call
• Stateflow
• For Each
• Action
• Initialize Function
• Reset Function
• Terminate Function
• Simulink Function

• The 'Compact' option for ERTFilePackagingFormat if PreserveStaticInFcnDecl is set to
'on'.

• AUTOSAR generated code.
• Subsystems that generate in-lined code. The subsystem block parameter RTWSystemCode must be

'Nonreusable function' or 'Reusable function'.
• Subsystems that contain:

• Referenced models.
• Simulink Function blocks.
• Data Store Memory, Data Store Read, and Data Store Write blocks.

• LDRA Testbed® and BullseyeCoverage tools for code coverage analysis.
• Signal and state data logging.
• Virtual buses at the subsystem interface.

The results from model and SIL or PIL simulations might differ numerically if:

• The subsystem uses non-finite numbers, for example, NaN and Inf.
• The subsystem and the parent model have multiple sample rates and rate transitions.

Variant Condition Propagation with Variant Source and Variant Sink Blocks

SIL/PIL block simulations do not support the propagation of variant conditions across component
boundaries.
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PIL Block Mux

The PIL block supports mux signals, except mixed data-type mux signals that expand into individual
signals during a right-click subsystem build.

Code Coverage

SIL block simulations do not support the generation of code coverage results. PIL block support for
code coverage depends on your target connectivity configuration and third-party product support.

Subsystem with Inherited Sample Time Blocks

When you create a SIL/PIL block from a subsystem that has blocks with inherited sample times, the
generated code and SIL/PIL wrapper acquire the sample time of the original parent model. If you use
the SIL/PIL block in a context that does not allow explicit sample times, for example, within a
triggered subsystem, you see an error.

Try one of these workarounds:

• Before you create the SIL/PIL block, in the parent model, set Configuration Parameters >
Solver > Periodic sample time constraint to Ensure sample time independent.

• Using the subsystem, create a Model block that is independent of sample time. With this block,
run Model block SIL/PIL simulations.

See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
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Test Generated Code with SIL and PIL Simulations
Test numerical equivalence between model components and production code that you generate from
the components by using software-in-the-loop (SIL) and processor-in-the-loop (PIL) simulations.

With a SIL simulation, you test source code on your development computer. With a PIL simulation,
you test the compiled object code that you intend to deploy in production by running the object code
on real target hardware or an instruction set simulator. To determine whether model components and
generated code are numerically equivalent, compare SIL and PIL results against normal mode
results.

There are three ways of running SIL and PIL simulations. You can use the top model, Model blocks, or
SIL and PIL blocks that you create from a subsystem. See “Choose a SIL or PIL Approach” on page
80-11.

Target Connectivity Configuration for PIL

Before you can run PIL simulations, you must configure target connectivity. The target connectivity
configuration enables the PIL simulation to:

• Build the target application.
• Download, start, and stop the application on the target.
• Support communication between Simulink and the target.

To produce a target connectivity configuration, you can use the supplied target connectivity API. For
details, see “Create PIL Target Connectivity Configuration for Simulink” on page 80-39.

For supported hardware, you can use target support packages. For details, see “Embedded Coder
Supported Hardware”.

SIL or PIL Simulation with a Top Model

Test generated model code by running a top-model SIL or PIL simulation. With this approach:

• You test code generated from the top model, which uses the standalone code interface.
• You configure the model to load test vectors or stimulus inputs from the MATLAB workspace.
• You can easily switch the top model between the normal, SIL, and PIL simulation modes.

Open a simple counter top model.

model='rtwdemo_sil_topmodel';
close_system(model,0)
open_system(model)
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To focus on numerical equivalence testing, turn off:

• Model coverage
• Code coverage
• Execution time profiling

set_param(gcs, 'RecordCoverage','off');
coverageSettings = get_param(model, 'CodeCoverageSettings');
coverageSettings.CoverageTool='None';
set_param(model, 'CodeCoverageSettings',coverageSettings);
set_param(model, 'CodeExecutionProfiling','off');

Configure the input stimulus data.
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[ticks_to_count, reset, counter_mode, count_enable] = ...
    rtwdemo_sil_topmodel_data(T);

Configure logging options in the model.

set_param(model, 'LoadExternalInput','on');
set_param(model, 'ExternalInput','ticks_to_count, reset, counter_mode, count_enable');
set_param(model, 'SignalLogging', 'on');
set_param(model, 'SignalLoggingName', 'logsOut');
set_param(model, 'SaveOutput','on')

Run a normal mode simulation.

set_param(model,'SimulationMode','normal')
sim_output = sim(model,10);
yout_normal = [sim_output.yout.signals(1).values sim_output.yout.signals(2).values];

Run a top-model SIL simulation.

set_param(model,'SimulationMode','Software-in-the-Loop (SIL)')
sim_output = sim(model,10);
yout_sil = [sim_output.yout.signals(1).values sim_output.yout.signals(2).values];

### Starting build procedure for: rtwdemo_sil_topmodel
### Successful completion of build procedure for: rtwdemo_sil_topmodel

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
rtwdemo_sil_topmodel  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 16.802s
### Preparing to start SIL simulation ...
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Updating code generation report with SIL files ...
### Starting SIL simulation for component: rtwdemo_sil_topmodel
### Stopping SIL simulation for component: rtwdemo_sil_topmodel

Unless up-to-date code for this model exists, new code is generated and compiled. The generated
code runs as a separate process on your computer.

Plot and compare the results of the normal and SIL simulations. Observe that the results match.

fig1 = figure;
subplot(3,1,1), plot(yout_normal), title('Counter Output for Normal Simulation')
subplot(3,1,2), plot(yout_sil), title('Counter Output for SIL Simulation')
subplot(3,1,3), plot(yout_normal-yout_sil), ...
    title('Difference Between Normal and SIL');
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Clean up.

close_system(model,0);
if ishandle(fig1), close(fig1), end
clear fig1
simResults = {'yout_sil','yout_normal','model','T',...
              'ticks_to_count','reset'};
save([model '_results'],simResults{:});
clear(simResults{:},'simResults')

SIL or PIL Simulation with a Model Block

Test generated model code by using a test harness model that runs a Model block in SIL mode. With
this approach:

• You can test code that is generated from a top model or a referenced model. The code from the top
model uses the standalone code interface. The code from the referenced model uses the model
reference code interface. For more information, see “Code Interfaces for SIL and PIL” on page 80-
5.

• You use a test harness model or a system model to provide test vector or stimulus inputs.
• You can easily switch a Model block between the normal, SIL, and PIL simulation modes.

Open an example model that has two Model blocks which reference the same model. In a simulation,
you run one Model block in SIL mode and the other Model block in normal mode.

model='rtwdemo_sil_modelblock';
open_system(model);
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Turn off:

• Code coverage
• Execution time profiling

coverageSettings = get_param(model, 'CodeCoverageSettings');
coverageSettings.CoverageTool='None';
set_param(model, 'CodeCoverageSettings',coverageSettings);
open_system('rtwdemo_sil_modelblock')
set_param('rtwdemo_sil_modelblock', 'CodeExecutionProfiling','off');
open_system('rtwdemo_sil_counter')
set_param('rtwdemo_sil_counter', 'CodeExecutionProfiling','off');
currentFolder=pwd;
save_system('rtwdemo_sil_counter', fullfile(currentFolder,'rtwdemo_sil_counter.slx'))
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Configure state logging for the models.

set_param('rtwdemo_sil_counter', 'SaveFormat','Dataset');
save_system('rtwdemo_sil_counter', fullfile(currentFolder,'rtwdemo_sil_counter.slx'))
set_param(model, 'SaveFormat','Dataset');
set_param(model, 'SaveState','on');
set_param(model, 'StateSaveName', 'xout');

Test Top-Model Code

For the Model block in SIL mode, specify generation of top-model code, which uses the standalone
code interface.

set_param([model '/CounterA'], 'CodeInterface', 'Top model');

Run a simulation of the test harness model.

out = sim(model,20);

### Starting build procedure for: rtwdemo_sil_counter
### Successful completion of build procedure for: rtwdemo_sil_counter

Build Summary

Top model targets built:

Model                Action                       Rebuild Reason                                    
====================================================================================================
rtwdemo_sil_counter  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.713s
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### Preparing to start SIL simulation ...
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Updating code generation report with SIL files ...
The top model "rtwdemo_sil_modelblock" is configured to load initial state and / or save states (see Data Import/Export configuration parameters). However, the SIL or PIL component "rtwdemo_sil_modelblock/CounterA" does not expose any states to Simulink and therefore cannot participate in state initialization or logging.
### Starting SIL simulation for component: rtwdemo_sil_counter
### Stopping SIL simulation for component: rtwdemo_sil_counter

The model block in SIL mode runs as a separate process on your computer. In the working folder, you
see that standalone code is generated for the referenced model unless generated code from a
previous build exists.

Compare the behavior of Model blocks in normal and SIL modes. The results match.

yout = out.logsOut;
yout_sil = yout.get('counterA').Values.Data;
yout_normal = yout.get('counterB').Values.Data;
fig1 = figure;
subplot(3,1,1), plot(yout_normal), title('Counter Output for Normal Simulation')
subplot(3,1,2), ...
    plot(yout_sil), title('Counter Output for Model Block SIL (Top-Model) Simulation')
subplot(3,1,3), plot(yout_normal-yout_sil), ...
    title('Difference Between Normal and SIL');

Compare the logged states of Model blocks from normal and SIL mode simulations.

xout = out.xout;
xout_sil = xout{1}.Values.Data;
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xout_normal = xout{2}.Values.Data;
fig1 = figure;
subplot(3,1,1), plot(xout_sil), title('State Logging for Normal Simulation')
subplot(3,1,2), ...
    plot(xout_normal), title('State Logging for Model Block SIL (Top-Model) Simulation')
subplot(3,1,3), plot(xout_normal-xout_sil), ...
    title('Difference Between Normal and SIL');

Test Model Reference Code

For the Model block in SIL mode, specify generation of referenced model code, which uses the model
reference code interface.

set_param([model '/CounterA'], 'CodeInterface', 'Model reference');

Run a simulation of the test harness model.

out2 = sim(model,20);

### Starting serial model reference code generation build
### Starting build procedure for: rtwdemo_sil_counter
### Successful completion of build procedure for: rtwdemo_sil_counter

Build Summary

Code generation targets built:

Model                Action                       Rebuild Reason                         
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=========================================================================================
rtwdemo_sil_counter  Code generated and compiled  rtwdemo_sil_counter.c does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 13.859s
### Preparing to start SIL simulation ...
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.
### Updating code generation report with SIL files ...
The top model "rtwdemo_sil_modelblock" is configured to load initial state and / or save states (see Data Import/Export configuration parameters). However, the SIL or PIL component "rtwdemo_sil_modelblock/CounterA" does not expose any states to Simulink and therefore cannot participate in state initialization or logging.
### Starting SIL simulation for component: rtwdemo_sil_counter
### Stopping SIL simulation for component: rtwdemo_sil_counter

The model block in SIL mode runs as a separate process on your computer. In the working folder, you
see that model reference code is generated unless code from a previous build exists.

Compare the behavior of Model blocks in normal and SIL modes. The results match.

yout2 = out2.logsOut;
yout2_sil = yout2.get('counterA').Values.Data;
yout2_normal = yout2.get('counterB').Values.Data;
fig1 = figure;
subplot(3,1,1), plot(yout2_normal), title('Counter Output for Normal Simulation')
subplot(3,1,2), ...
    plot(yout2_sil), title('Counter Output for Model Block SIL (Model Reference) Simulation')
subplot(3,1,3), plot(yout2_normal-yout2_sil), ...
   title('Difference Between Normal and SIL');
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Compare the logged states of Model blocks from normal and SIL mode simulations.

xout2 = out.xout;
xout2_sil = xout2{1}.Values.Data;
xout2_normal = xout2{2}.Values.Data;
fig1 = figure;
subplot(3,1,1), plot(xout2_sil), title('State Logging for Normal Simulation')
subplot(3,1,2), ...
    plot(xout2_normal), title('State Logging for Model Block SIL (Model Reference) Simulation')
subplot(3,1,3), plot(xout2_normal-xout2_sil), ...
    title('Difference Between Normal and SIL');

Clean up.

close_system(model,0);
if ishandle(fig1), close(fig1), end, clear fig1
simResults={'out','yout','yout_sil','yout_normal', ...
            'out2','yout2','yout2_sil','yout2_normal', ...
            'SilCounterBus','T','reset','ticks_to_count','Increment'};
save([model '_results'],simResults{:});
clear(simResults{:},'simResults')

SIL or PIL Block Simulation

Test generated subsystem code by using a SIL or PIL block in a simulation. With this approach:

• You test code generated from subsystems, which uses the standalone code interface.
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• You provide a test harness or a system model to supply test vector or stimulus inputs.
• You replace your original subsystem with the generated SIL or PIL block.

Open a simple model, which consists of a control algorithm and a plant model in a closed loop. The
control algorithm regulates the output from the plant.

model='rtwdemo_sil_block';
close_system(model,0)
open_system(model)

Run a normal mode simulation

out = sim(model,10);
yout_normal = out.yout;
clear out

Configure the build process to create the SIL block for testing.

set_param(model,'CreateSILPILBlock','SIL');

To test the behavior on production hardware, specify a PIL block.

To create the SIL block, generate code for the control algorithm subsystem. You see the SIL block at
the end of the build process. Its input and output ports match those of the control algorithm
subsystem.

close_system('untitled',0);
slbuild([model '/Controller'])

### Starting build procedure for: Controller
### Successful completion of build procedure for: Controller
### Creating SIL block ...
Building with 'Microsoft Visual C++ 2019 (C)'.
MEX completed successfully.

Build Summary

Top model targets built:
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Model       Action                       Rebuild Reason                                    
===========================================================================================
Controller  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 27.179s

Alternatively, you can right-click the subsystem and select C/C++ Code > Build This Subsystem. In
the dialog box that opens, click Build.

To perform a SIL simulation of the controller and plant model in a closed loop, replace the original
control algorithm with the new SIL block. To avoid losing your original subsystem, do not save your
model in this state.

controllerBlock = [model '/Controller'];
blockPosition = get_param(controllerBlock,'Position');
delete_block(controllerBlock);
add_block('untitled/Controller',[controllerBlock '(SIL)'],...
          'Position', blockPosition);
close_system('untitled',0);
clear controllerBlock blockPosition

Run the SIL simulation.

out = sim(model,10);

### Preparing to start SIL block simulation: rtwdemo_sil_block/Controller(SIL) ...
### Starting SIL simulation for component: rtwdemo_sil_block
### Stopping SIL simulation for component: rtwdemo_sil_block

The control algorithm uses single-precision, floating-point arithmetic. You can expect the order of
magnitude for differences between SIL and normal simulations to be close to the machine precision
for single-precision data.

Define an error tolerance for SIL simulation results that is based on the machine precision for the
single-precision, normal simulation results.

machine_precision = eps(single(yout_normal));
tolerance = 4 * machine_precision;

Compare normal and SIL simulation results. In the third plot, the differences between the simulations
lie well within the defined error tolerance.

yout_sil = out.yout;
tout = out.tout;
fig1 = figure;
subplot(3,1,1), plot(yout_normal), title('Controller Output for Normal Simulation')
subplot(3,1,2), plot(yout_sil), title('Controller Output for SIL Simulation')
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subplot(3,1,3), plot(tout,abs(yout_normal-yout_sil),'g-', tout,tolerance,'r-'), ...
    title('Normal and SIL Difference and Error Tolerance');

Clean up.

close_system(model,0);
if ishandle(fig1), close(fig1), end
clear fig1
simResults={'out','yout_sil','yout_normal','tout','machine_precision'};
save([model '_results'],simResults{:});
clear(simResults{:},'simResults')

Hardware Implementation Settings

When you run a SIL simulation, you must configure your hardware implementation settings
(characteristics such as native word sizes) to allow compilation for your development computer.
These settings can differ from the hardware implementation settings that you use when building the
model for your production hardware. To avoid the need to change hardware implementation settings
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between SIL and PIL simulations, enable portable word sizes. For more information, see “Configure
Hardware Implementation Settings” on page 80-20.

See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Configure and Run SIL Simulation” on page 80-15
• “Configure Hardware Implementation Settings” on page 80-20
• “Code Execution Profiling with SIL and PIL” on page 74-2
• “Configure Code Coverage with Third-Party Tools” on page 83-8
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Create a Target Communication Channel for Processor-In-The-
Loop (PIL) Simulation

Implement a communication channel for processor-in-the-loop (PIL) simulation.

The communication channel enables exchange of data between different processes. The
communication channel supports capabilities that require the exchange of data between the
Simulink® software environment that runs on your development computer (host) and deployed code
that runs on target hardware. For example, a PIL simulation.

You learn about the rtiostream interface and how it provides a generic communication channel that
you can implement in the form of target connectivity drivers for different connection types. This
example describes how to use the default TCP/IP implementation.

Two entities, Station A and Station B, use the rtiostream interface to set up a communication channel
and exchange data. For this example, Station A and Station B are configured within the same process
on your desktop computer.

The target connectivity drivers support an on-target PIL simulation. In the simulation, Station A and
Station B represent the target and host computers that exchange data via the communication
channel. On the host side, the target connectivity driver is implemented as a shared library that is
loaded and called from within the MATLAB® product. On the target side, the driver is source code or
a library that is linked to the application that runs on the target.

Additionally, you can:

• Configure your own target-side driver for TCP/IP to operate with the default host-side TCP/IP
driver.

• Configure the supplied host-side driver for serial communications.
• Implement custom target connectivity drivers, for example, by using CAN or USB for host and

target sides of the communication channel.

See also “Test Generated Code with SIL and PIL Simulations” on page 80-85 and “Configure
Processor-In-The-Loop (PIL) for a Custom Target” on page 80-104.

View Source Code for the Default TCP/IP Implementation

The file rtiostream_tcpip.c implements client-side and server-side TCP/IP communication. A startup
parameter configures the driver to operate in either client or server mode. You can use this source
file as a starting point for a custom implementation. Each side of the communication channel requires
only one or the other of the server or client implementations. If the client and server drivers run on
different architectures, consider placing the driver code for each architecture in a separate source
file.

The header file rtiostream.h contains prototypes for the functions rtIOStreamOpen/Send/Recv/Close.
Include it (using #include) for custom implementations.

Extract the location of TCP/IP driver source code.

rtiostreamtcpip_dir=fullfile(matlabroot,'toolbox','coder','rtiostream','src',...
                              'rtiostreamtcpip');

View rtiostream_tcpip.c.
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edit(fullfile(rtiostreamtcpip_dir,'rtiostream_tcpip.c'));

View rtiostream.h.

edit(fullfile(matlabroot,'rtw','c','src','rtiostream.h'));

Location of Shared Library Files

To access the target connectivity drivers from the MATLAB product, you must compile them to a
shared library. The shared library must be located on your system path. A shared library for the
default TCP/IP drivers is located in matlabroot/bin/$ARCH ($ARCH is your system architecture, for
example, win64).

The shared library filename extension and location depends on your operating system.

[~, ~, sharedLibExt] = coder.BuildConfig.getStdLibInfo;

Identify the shared library for Station A and Station B.

libTcpip = ['libmwrtiostreamtcpip' sharedLibExt];
disp(libTcpip)

libmwrtiostreamtcpip.dll

Test the Target Connectivity Drivers

If you are implementing a custom target connectivity driver, it is helpful to test it from within the
MATLAB product. The following example shows how to load the default TCP/IP target connectivity
drivers and use them for data exchange between Station A and Station B.

To access the drivers, you can use the MEX-file rtiostream_wrapper. With this MEX-file, you can load
the shared library and access the rtiostream functions to open and close an rtiostream channel, and
send and receive data.

Station A and Station B run on the host computer. Station A is configured as a TCP/IP server and
Station B as a TCP/IP client. For host to target communication, you typically configure the host as a
TCP/IP client and the target as a TCP/IP server.

Choose a port number for TCP.

if usejava('jvm')
    % Find a free port
    tempSocket = java.net.ServerSocket(0);
    port = num2str(tempSocket.getLocalPort);
    tempSocket.close;
else
    % Use a hard-coded port
    port = '14646';
end

Open the Station A rtiostream as a TCP/IP server.

stationA = rtiostream_wrapper(libTcpip,'open',...
                                 '-client', '0',...
                                 '-blocking', '0',...
                                 '-port',port);
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If the communication channel opens, the return value is a handle to the connection. A return value of
-1 indicates an error.

Check the return value.

assert(stationA~=(-1))

Open the Station B rtiostream as a TCP/IP client.

stationB = rtiostream_wrapper(libTcpip,'open',...
                                 '-client','1',...
                                 '-blocking', '0',...
                                 '-port',port,...
                                 '-hostname','localhost');

If the communication channel opens, the return value is a handle to the connection. A return value of
-1 indicates an error.

Check the return value.

assert(stationB~=(-1))

Send Data from Station B to Station A

The target connectivity drivers send a stream of data in 8-bit bytes. For processors that are not byte-
addressable, the data is sent in the smallest addressable word size.

Send message data from Station B to Station A.

msgOut = uint8('Station A, this is Station B. Are you there? OVER');

[retVal, sizeSent] = rtiostream_wrapper(libTcpip,...
                                       'send',...
                                       stationB,...
                                       msgOut,...
                                       length(msgOut));

A return value of zero indicates success.

assert(retVal==0);

Make sure that bytes in the message were sent.

assert(sizeSent==length(msgOut));

Allow time for data transmission to be completed.

pause(0.2)

Receive data in Station A.

[retVal, msgRecvd, sizeRecvd] = rtiostream_wrapper(libTcpip,...
                                                 'recv',...
                                                 stationA,...
                                                 100);

A return value of zero indicates success.

assert(retVal==0);
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Make sure that bytes in the message were received.

assert(sizeRecvd==sizeSent);

Display the received data.

disp(char(msgRecvd))

Station A, this is Station B. Are you there? OVER                                                   

Send a Response from Station A to Station B

Send response data from Station A to Station B.

msgOut = uint8('Station B, this is Station A. Yes, I''m here! OVER.');
[~, sizeSent] = rtiostream_wrapper(libTcpip,... %#ok
                                       'send',...
                                       stationA,...
                                       msgOut,...
                                       length(msgOut));

Allow time for data transmission to be completed.

pause(0.2)

Receive data in Station B.

[~, msgRecvd, sizeRecvd] = rtiostream_wrapper(libTcpip,... %#ok
                                                 'recv',...
                                                 stationB,...
                                                 100);

Display the received data.

disp(char(msgRecvd))

Station B, this is Station A. Yes, I'm here! OVER.                                                  

Close Connection and Unload Shared Libraries

Close rtiostream on Station B.

retVal = rtiostream_wrapper(libTcpip,'close',stationB);

A return value of zero indicates success.

assert(retVal==0);

Close rtiostream on Station A.

retVal = rtiostream_wrapper(libTcpip,'close',stationA);

A return value of zero indicates success.

assert(retVal==0)

Unload the shared library.

rtiostream_wrapper(libTcpip, 'unloadlibrary');
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Host-Side Driver for Serial Communications

You can use the supplied host-side driver for serial communications as an alternative to the drivers
for TCP/IP. To configure the serial driver, see rtiostream_wrapper in the Embedded Coder®
reference documentation.

Configure Your Own Target-Side Driver

If your target has an Ethernet connection and you have a TCP/IP stack available, follow these steps:

1 Write a wrapper for your TCP/IP stack that makes it available via the rtiostream interface defined
in rtiostream.h.

2 Write a test application for your target that sends and receives some data.
3 Use the rtiostream_wrapper MEX-file and host-side TCP/IP driver to test your driver software

that is running on the target.
4 When you have a working target-side driver, include the driver source files in the build for your

automatically generated code.

You can configure your target-side driver to operate only as a TCP/IP server because the default host-
side driver for PIL is configured as a TCP/IP client.

If you need to use a communications channel that is not already supported on the host-side, write
drivers for host and target. In this case, you can still use the rtiostream_wrapper MEX-file for testing
your rtiostream drivers.

Configure Your Own Host-Side Driver

You can implement the target connectivity drivers by using different communication channels. For
example, you can implement host-target communications via a special serial connection, which
requires that you provide drivers for the host and target.

On the host side, you can test the drivers by using the rtiostream_wrapper MEX-file. If your driver
includes diagnostic output from printf statements and rtiostream_wrapper loads the shared library,
you must replace the printf statements with mexPrintf statements.

When you have a working host-side device driver, you must make it available within the Simulink
software environment. For PIL simulation, register the shared host-side shared library via
sl_customization.

See Also

Related Examples
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Host-Target Communication for Simulink PIL simulation” on page 80-43
• “Test Generated Code with SIL and PIL Simulations” on page 80-85
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Configure Processor-In-The-Loop (PIL) for a Custom Target
Create a target connectivity configuration by using target connectivity APIs. With a target
connectivity configuration, you can run processor-in-the-loop (PIL) simulations on custom embedded
hardware.

You learn how to:

• Adapt the build process to support PIL simulations.
• Configure a tool for downloading and starting execution of a PIL executable on your target

hardware.
• Configure a communication channel between host and target to support PIL simulation on the

target hardware.

Start with a model configured for software-in-the-loop (SIL) simulation. This example guides you
through the process of creating a target connectivity configuration so that you can simulate the
model in PIL mode. The example runs entirely on your host computer. You can follow the same steps
to create a connectivity configuration for your own embedded target hardware.

See also “Test Generated Code with SIL and PIL Simulations” on page 80-85 and “Create a Target
Communication Channel for Processor-In-The-Loop (PIL) Simulation” on page 80-99.

Preliminaries

Later in this example, you will add a folder to the search path. Create the folder path.

sl_customization_path = fullfile(matlabroot,...
    'toolbox',...
    'rtw',...
    'rtwdemos',...
    'pil_demo');

If this folder is already on the search path, remove it.

if strfind(path,sl_customization_path)
    rmpath(sl_customization_path)
end

Reset customizations.

sl_refresh_customizations

Create a temporary folder (in your system's temporary folder) for the build and inspection process.

currentDir = pwd;
rtwdemodir();

Test Generated Code with SIL Simulation

Simulate a model configured for SIL. Verify the generated code compiled for your host computer by
comparing the SIL simulation behavior with the normal simulation behavior.

Make sure that the example model is newly opened.
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close_system('rtwdemo_sil_modelblock',0);
close_system('rtwdemo_sil_counter',0)
open_system('rtwdemo_sil_modelblock')

The CounterA Model block displays the text (SIL), which indicates that its referenced model is
configured for SIL simulation.

Run a simulation of the system.

set_param('rtwdemo_sil_modelblock','StopTime','10');
sim('rtwdemo_sil_modelblock');

### Starting build procedure for model: rtwdemo_sil_counter
### Successful completion of build procedure for model: rtwdemo_sil_counter
### Preparing to start SIL simulation ...
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Updating code generation report with SIL files ...
### Starting SIL simulation for component: rtwdemo_sil_counter
### Stopping SIL simulation for component: rtwdemo_sil_counter

Target Connectivity Configuration

Start work on a target connectivity configuration for PIL.

Make a local copy of the target connectivity configuration classes.

src_dir = ...
    fullfile(matlabroot,'toolbox','coder','simulinkcoder','+coder','+mypil');
if exist(fullfile('.','+mypil'),'dir')
    rmdir('+mypil','s')
end
mkdir +mypil
copyfile(fullfile(src_dir,'Launcher.m'), '+mypil');
copyfile(fullfile(src_dir,'TargetApplicationFramework.m'), '+mypil');
copyfile(fullfile(src_dir,'ConnectivityConfig.m'), '+mypil');

Make the copied files writable.

fileattrib(fullfile('+mypil', '*'),'+w');

Update the package name to reflect the new location of the files.

coder.mypil.Utils.UpdateClassName(...
    './+mypil/ConnectivityConfig.m',...
    'coder.mypil',...
    'mypil');

Verify that you now have a folder +mypil in the current folder, which has the files Launcher.m,
TargetApplicationFramework.m, and ConnectivityConfig.m.

dir './+mypil'

.                             Launcher.m                    

..                            TargetApplicationFramework.m  
ConnectivityConfig.m          
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Review Code to Launch the PIL Executable

The class that configures a tool for launching the PIL executable is mypil.Launcher. Open this class in
the editor.

edit(which('mypil.Launcher'))

Review the content of this file. The method setArgString supplies additional command-line
parameters to the executable. These parameters can include a TCP/IP port number. For an embedded
processor implementation, you can choose to hard-code these settings.

Configure the Overall Target Connectivity Configuration

View the class mypil.ConnectivityConfig.

edit(which('mypil.ConnectivityConfig'))

Review the content of this file. You should be able to identify:

• The creation of an instance of rtw.connectivity.RtIOStreamHostCommunicator that configures the
host side of the TCP/IP communications channel.

• A call to the setArgString method of Launcher that configures the target side of the TCP/IP
communications channel.

• A call to setTimer that configures a timer for execution time measurement

To define your own target-specific timer for execution time profiling, you must use the Code
Replacement Library to specify a replacement for the function code_profile_read_timer. Use a
command-line API or the crtool user interface.

Review the Target-Side Communications Drivers

View the file rtiostream_tcpip.c.

rtiostreamtcpip_dir=fullfile(matlabroot,'toolbox','coder','rtiostream','src',...
    'rtiostreamtcpip');
edit(fullfile(rtiostreamtcpip_dir,'rtiostream_tcpip.c'))

Scroll down to the end of this file. See that this file contains a TCP/IP implementation of the functions
rtIOStreamOpen, rtIOStreamSend, and rtIOStreamRecv. These functions are required for the target
hardware to communicate with your host computer. You must provide an implementation for each of
these functions that is specific to your target hardware and communication channel.

Add Target-Side Communications Drivers to the Connectivity Configuration

The class that configures additional files to include in the build is mypil.TargetApplicationFramework.
Open this class in the editor.

edit(which('mypil.TargetApplicationFramework'))

Use sl_customization to Register the Target Connectivity Configuration

To use the new target connectivity configuration, you must provide an sl_customization file. The
sl_customization file registers your new target connectivity configuration and specifies the required
conditions for its use. The conditions specified in this file can include the name of your system target
file and your hardware implementation settings.
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You can view the sl_customization file. For this example, you do not have to make changes to the file.

edit(fullfile(sl_customization_path,'sl_customization.m'))

Add the sl_customization folder to the search path and refresh the customizations.

addpath(sl_customization_path);
sl_refresh_customizations;

Test Generated Code with PIL Simulation

Run the PIL simulation.

close_system('rtwdemo_sil_modelblock',0)
open_system('rtwdemo_sil_modelblock')
set_param('rtwdemo_sil_modelblock/CounterA','SimulationMode','processor-in-the-loop (pil)');
set_param('rtwdemo_sil_modelblock','StopTime','10');
sim('rtwdemo_sil_modelblock');

### Starting build procedure for model: rtwdemo_sil_counter
### Generated code for 'rtwdemo_sil_counter' is up to date because no structural, parameter or code replacement library changes were found.
### Successful completion of build procedure for model: rtwdemo_sil_counter
### Connectivity configuration for referenced model "rtwdemo_sil_counter": My PIL Example ###
EXECUTING METHOD SETARGSTRING
SETARGSTRING called from line 71 of ConnectivityConfig.m
### Preparing to start PIL simulation ...
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Updating code generation report with PIL files ...
### Starting application: 'rtwdemo_sil_counter_ert_rtw\pil\rtwdemo_sil_counter.exe'
Starting PIL simulation
Started new process, pid = 14132
Stopping PIL simulation
Terminated process, pid = 14132

Review the preceding messages. Confirm that the simulation ran without errors. You have now
implemented a target connectivity configuration for PIL. You can use the same APIs to implement a
connectivity configuration for your own combination of embedded processor, download tool, and
communications channel.

Cleanup

Remove the search path for this example.

rmpath(sl_customization_path)

Reset customizations.

sl_refresh_customizations

Close the models.

close_system('rtwdemo_sil_modelblock',0)
close_system('rtwdemo_sil_counter',0)
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rtwdemoclean;
cd(currentDir)

See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Configure and Run PIL Simulation” on page 80-26

80 Numerical Equivalence Checking in Embedded Coder

80-108



Field-Oriented Control of Permanent Magnet Synchronous
Machine

This example shows the basic workflow and key APIs for generating C code from a motor control
algorithm, and for verifying its compiled behavior and execution time. You will use Processor-in-the-
loop (PIL) simulation to gain confidence that the C code will perform as expected when you integrate
it with embedded software that interfaces with the motor hardware. Although this workflow uses a
motor control application for a specific processor, you can apply this workflow to virtually any
application or processor.

We use a Field-Oriented Control algorithm for a Permanent Magnet Synchronous Machine to show
this workflow. This control technique is common in motor drive systems for hybrid electric vehicles,
manufacturing machinery, and industrial automation.

Overview

In this example, generate and verify C code from a control algorithm model, which you can integrate
with additional embedded software required to interface to motor hardware.

You will use a simulation environment to model and verify the behavior of a closed-loop motor control
system. Once the control system behavior is within specification, you will generate C code from the
controller model. After inspecting the code, you will assess its functional behavior and execution time
using processor-in-the-loop (PIL) testing.

 Field-Oriented Control of Permanent Magnet Synchronous Machine

80-109



To facilitate PIL testing, you will select test signals to exercise the controller model and establish
reference outputs. You will review an example PIL implementation for a Texas Instruments™ F28335
processor that communicates with Simulink® on the host computer over a serial connection. You can
use this example as a starting point to create a PIL implementation for your own processor. You will
run the controller model in PIL mode to measure execution time and verify execution behavior of the
code running on the embedded processor against the simulation reference outputs.

In the final implementation on the embedded processor, you would integrate the generated controller
C code with additional embedded software, such as peripherals and interrupts, required to interface
with the motor hardware.

Notes

• Simscape™ Electrical is required for system simulation in the section "Verify Behavior through
System Simulation." It is not required for other tasks.

• The Texas Instruments™ F28335 PIL implementation is a reference approach that you can apply
to virtually any processor. However, if you wish to use this implementation directly, you will need
additional support files, compilers, and tools from Texas Instruments™. You can find more
information about those in "Create PIL Implementation and Register with Simulink®" section of
this example. This reference PIL implementation does not require the Texas Instrument C2000™
Embedded Target feature of Embedded Coder®, but C2000™ users are encouraged to install
Texas Instruments C2000 Support Package using Add-On Explorer.

Verify Behavior through System Simulation

In this section, you will verify the controller in a closed loop system simulation.

The system model test bench consists of test inputs, the embedded processor, the power electronics
and motor hardware, and visualizations. You can use the system model to exercise the controller and
explore its expected behavior. You can use the following commands to execute the model and plot
logged signals.
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matlab:supportPackageInstaller


open_system('rtwdemo_pmsmfoc_system')
out_system = sim('rtwdemo_pmsmfoc_system')
rtwdemo_pmsmfoc_plotsignals(out_system.logsout)

out_system = 

  Simulink.SimulationOutput:
                logsout: [1x1 Simulink.SimulationData.Dataset] 

     SimulationMetadata: [1x1 Simulink.SimulationMetadata] 
           ErrorMessage: [0x0 char] 
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The plots show that the motor is stationary until the motor_on signal is true. The motor then spins in
an open loop until a known position is detected, which is indicated by the encoder index pulse. The
controller then transitions to closed loop operation and the motor reaches a steady state speed.

Explore Model Architecture

In this section, you will explore the model architecture including how data is specified, how the
controller is partitioned from the test bench, and how controller is scheduled. This architecture
facilitates system simulation, algorithmic code generation, and PIL testing.

A data definition file creates the MATLAB® data required for simulation and code generation. This
data file is automatically run within the PreLoadFcn callback of the system test bench model.

edit('rtwdemo_pmsmfoc_data.m')

Within the system test bench model, the embedded processor is modeled as a combination of the
peripherals and the controller software.

open_system('rtwdemo_pmsmfoc_system/Embedded Processor')

80 Numerical Equivalence Checking in Embedded Coder

80-112



The controller software is specified in a separate model. Within this model, the Mode_Scheduler
subsystem uses Stateflow® to schedule different modes of operation of the Motor_Control algorithm.

open_system('rtwdemo_pmsmfoc')
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Within the Motor_Control subsystem, sensor signals are converted to engineering units and passed to
the core controller algorithm. The controller algorithm calculates voltages. The voltages are then
converted to a driver signal.

open_system('rtwdemo_pmsmfoc/Motor_Control')
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The primary control law is a field-oriented controller. The controller has a low rate outer loop that
controls the speed, and a higher rate inner loop that controls the current.

open_system('rtwdemo_pmsmfoc/Motor_Control/Field_Oriented_Controller')
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The Velocity Controller outer loop is executed as a multiple of the Current Control loop time. You can
view the MATLAB® variables, which specify these sample times:

fprintf('High rate sample time = %f seconds\n', ctrlConst.TsHi)
fprintf('Low rate sample time  = %f seconds\n', ctrlConst.TsLo)

High rate sample time = 0.000040 seconds
Low rate sample time  = 0.005000 seconds

Notice that the highest rate in the controller algorithm is 25 kHz.

fprintf('High rate frequency = %5.0f Hz\n', 1/ctrlConst.TsHi)

High rate frequency = 25000 Hz

Generate Controller C Code for Integration into Embedded Application

In this section, you will generate and visually inspect the C code function for the controller.

To ease integration, the controller model is configured in single-tasking mode so that the generated
code can be invoked using one function call. This function handles the lower and higher rates. The
generated controller function must be executed at the high rate sample time.
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The function prototype is specified in the model configuration parameters and the input and output
ports are passed as arguments. You can view the function specification for the controller algorithm.

mdlFcn = RTW.getFunctionSpecification('rtwdemo_pmsmfoc');
disp(mdlFcn.getPreview('init'))
disp(mdlFcn.getPreview('step'))

Controller_Init ( )
error = Controller ( motor_on, command_type, current_request, * sensors, * pwm_compare )

Through use of a global structure in the generated code, you can access the field-oriented controller
proportional and integral gains. This global structure is specified in the data definition file.

disp(ctrlParams.Value)
disp(ctrlParams.CoderInfo)

                            Current_P: 10
                            Current_I: 10000
                           Velocity_P: 0.0050
                           Velocity_I: 0.0150
                           Position_P: 0.1000
                           Position_I: 0.6000
                  StartupAcceleration: 1
                       StartupCurrent: 0.2000
                   RampToStopVelocity: 20
             AdcZeroOffsetDriverUnits: 2.2523e+03
                 AdcDriverUnitsToAmps: 0.0049
    EncoderToMechanicalZeroOffsetRads: 0
                        PmsmPolePairs: 4

Simulink.CoderInfo
    StorageClass: 'ExportedGlobal'
      Identifier: ''
       Alignment: -1

You generate C code from the model as follows.

slbuild('rtwdemo_pmsmfoc')

### Starting build procedure for: rtwdemo_pmsmfoc
### Successful completion of build procedure for: rtwdemo_pmsmfoc

Build Summary

Top model targets built:

Model            Action                       Rebuild Reason                                    
================================================================================================
rtwdemo_pmsmfoc  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 59.217s

Use the generated report to inspect the generated C code file and verify that the correct step and
initialization functions were generated. Also verify that the parameter structure was created as a
global variable.
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Establish Reference Behavior for Controller Model

In this section, you will establish test inputs and a reference output to help verify behavior and profile
execution time during PIL testing. You will make a local copy of the controller model then load a set
of test input signals that exercise the different modes within the controller. You will then configure
the controller model to attach these logged signals to input ports, execute the controller model, and
log the output port signal to the workspace.

Configuration parameters of the controller model used to establish the reference behavior and test
environment will change as described below. Blocks and parameters used to specify the controller
model's design and generate production code will not change. However, to avoid modifying any part
of the installed controller model, save the model and change its name to
rtwdemo_pmsmfoc_local.slx.

save_system('rtwdemo_pmsmfoc','rtwdemo_pmsmfoc_local.slx')
close_system('rtwdemo_pmsmfoc_system',0);
close_system('rtwdemo_pmsmfoc',0);

omCallMethod failed on slmsgviewer.renameTab

To profile execution times, select a set of test inputs that will execute the paths of interest within the
controller. One way to acquire these test inputs and reference output is to log them from the system
simulation model.
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in.motor_on      = out_system.logsout.getElement('motor_on').Values;
in.command_type  = out_system.logsout.getElement('command_type').Values;
in.command_value = out_system.logsout.getElement('command_value').Values;
in.sensors       = out_system.logsout.getElement('sensors').Values;
display(in)

in = 

  struct with fields:

         motor_on: [1×1 timeseries]
     command_type: [1×1 timeseries]
    command_value: [1×1 timeseries]
          sensors: [1×1 struct]

These signals can now be attached to the input ports and imported into the controller model such
that it can execute directly and independently from the system model. An advantage of this approach
is that the controller model can be tested and verified as a standalone component, facilitating reuse
and integration with other system models or closed-loop test benches. To elaborate, or prepare, the
controller model for testing, change its Configuration Parameters to attach input signals and log
signals in the MATLAB® workspace. These changes can be made graphically in the model's
Configuration Parameters dialog, or programmatically as shown below.

set_param('rtwdemo_pmsmfoc_local',...
    'LoadExternalInput', 'on',...
    'ExternalInput', 'in.motor_on, in.command_type, in.command_value, in.sensors',...
    'StopTime','0.06',...
    'ZeroInternalMemoryAtStartup','on',...
    'SimulationMode', 'normal')
save_system('rtwdemo_pmsmfoc_local.slx')

You can now execute the controller model and plot the signal associated with the PWM Compare
output port.

out = sim('rtwdemo_pmsmfoc_local')
controller_mode = out.logsout.getElement('controller_mode').Values;
pwm_compare_ref = out.logsout.getElement('pwm_compare').Values;
rtwdemo_pmsmfoc_plotpwmcompare(controller_mode, pwm_compare_ref)

out = 

  Simulink.SimulationOutput:
                logsout: [1x1 Simulink.SimulationData.Dataset] 

     SimulationMetadata: [1x1 Simulink.SimulationMetadata] 
           ErrorMessage: [0x0 char] 
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The logged output will be used as the reference behavior for PIL testing.

Notice that the plot is annotated with information about the mode of the controller at each time step.
This mode information will be useful when interpreting execution profiling information.

Create PIL Implementation

In this section, you will study and use an example PIL implementation. You will begin by reviewing
prerequisite help documentation from Embedded Coder®. You will then copy the example PIL
implementation into your local directory and register it with Simulink®. You will review the approach
used to develop the PIL implementation and can explore the associated files to gain additional
insight. If you are using a Spectrum Digital Inc. eZdsp F28335 board with Code Composer v4 and a
serial connection, you will be able to configure this PIL implementation to directly work with the
controller model. If you are using a different processor, you can use this PIL implementation as a
starting point to create your own implementation.

The fundamentals of creating a custom PIL implementation are described in “Create PIL Target
Connectivity Configuration for Simulink” on page 80-39 . You should familiarize yourself with the
basic concept of using the rtiostream API to facilitate communication between Simulink® (host-side)
and the embedded processor (target-side) during PIL testing. Note that Embedded Coder® provides
host-side drivers for the default TCP/IP implementation (for all platforms supported by Simulink®) as
well as a Windows® only version for serial communication. Building the generated code is
accomplished using a makefile as described in “Customize Template Makefiles” . To create a PIL
implementation you will need to perform several tasks in the embedded environment including
writing a target-side communications driver, writing a makefile to build the generated code, and
automating download and execution of the built executable.
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Using the above approach, a PIL implementation was created for a Spectrum Digital Inc. eZdsp
F28335 board. Below is a summary of the target connectivity API components used in this
implementation.

• Host-Side Communication - The host-side connectivity driver is configured to use serial
communication.

• Target-Side Communication - The target-side communication is achieved using a handwritten
serial implementation of the rtiostream functions as well as timer access functions.

• Build Process - A makefile based approach is used to build the executable application.
• Launcher - Downloading and running the executable is accomplished using the Debug Server

Scripting (DSS) utility of Code Composer Studio™ v4 (CCSv4).

The PIL implementation was iteratively developed in three stages. Below is a description of these
stages and the tasks performed in these stages. You may find it helpful to follow a similar approach
when developing your own PIL implementation

Stage 1: Create serial communication application with CCSv4

• Install CCSv4 and verify that it can connect with the F28335 eZdsp board.
• Write an embedded application that sends and receives serial data.
• Test the serial communication between the host computer and the embedded application.
• Identify the commands and options for the compiler, linker, and archiver to build the application

using a makefile.
• Download and run the application from a Windows® Command Prompt using the DSS utility.

Stage 2: Implement and test embedded serial rtiostream and launch automation with
MATLAB®

• Extend the serial application to implement the rtiostream API functions for echoing data. Write
the rtIOStreamOpen to perform general board initialization, including configuring the serial port.
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• Verify sending and receiving serial data with the embedded processor from MATLAB® using the
rtiostream_wrapper function.

• Download and run the application from MATLAB® using the system command to call the DSS
utility.

Stage 3: Implement and test connectivity configuration with Simulink®

• Create a connectivity configuration class to configure the host-side serial communication, specify
which target-side code files from the rtiostream application should be included in the build
process, specify how to access a timer that will be used to collect profiling data, and integrate
calling the DSS utility to launch the embedded application.

• Create a tool specification makefile (target_tools.mk) which specifies the commands and
options for the compiler, linker, and archiver. This makefile is included by the template makefile
(target_tools.mk).

• Create a template makefile (ec_target.tmf) that includes target_tools.mk.
• Identify parameters which may be installation dependent and store them as MATLAB®

preferences.
• Create a Simulink® customization file which specifies when the PIL implementation is valid

The files associated with this PIL implementation are included with Embedded Coder®, but are not
on the MATLAB® path. To explore these files, you can copy them into a local directory. You can
register this PIL implementation by adding this directory to the MATLAB® path and refreshing the
Simulink® customizations.

%copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','examplePilF28335'),'examplePilF28335','f')
addpath(genpath(fullfile(matlabroot,'toolbox','rtw','rtwdemos','examplePilF28335')))
sl_refresh_customizations

MATLAB® preferences are used to specify path information and the host serial COM port number. If
you are using this PIL implementation directly, you must specify these preferences as appropriate for
your configuration.

Note that the TI_F28xxx_SysSWDir preference points to a directory provided by Texas
Instruments™ in their C2000™ Experimenter Kit Application Software (sprc675.zip). These
files are not included with Embedded Coder®.

setpref('examplePilF28335','examplePilF28335Dir', fullfile(matlabroot,'toolbox','rtw','rtwdemos','examplePilF28335'));
setpref('examplePilF28335','CCSRootDir',          'C:\Program Files\Texas Instruments\ccsv4');
setpref('examplePilF28335','TI_F28xxx_SysSWDir',  'C:\Program Files\Texas Instruments\TI_F28xxx_SysSW');
setpref('examplePilF28335','targetConfigFile',    fullfile(matlabroot,'toolbox','rtw','rtwdemos','examplePilF28335','f28335_ezdsp.ccxml'));
setpref('examplePilF28335','baudRate',            115200);
setpref('examplePilF28335','cpuClockRateMHz',     150);
setpref('examplePilF28335','boardConfigPLL',      10);
setpref('examplePilF28335','COMPort',             'COM4');

The PIL implementation is now ready to be used.

Prepare Controller Model for PIL Testing

In this section you will configure the controller model to use the PIL implementation. You will review
the customization file used to register the PIL implementation, set the configuration parameters of
the model to use the PIL implementation, and enable logging controller outputs and execution
profiling data.
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When you begin a simulation in PIL mode, Simulink® will check if any of the registered PIL
implementations are valid. A customization file specifies which configuration parameters correspond
to a valid PIL implementation. You can explore the customization file for this implementation by
invoking the following command.

edit(fullfile(matlabroot,'toolbox','rtw','rtwdemos','examplePilF28335','sl_customization.m'));

Notice that this file specifies setting for the hardware device and the template makefile which are
required to use this PIL implementation. You can modify the configuration parameters in the
controller model to match these settings. These changes can be made graphically in the model's
Configuration Parameters dialog, or programmatically as shown below.

set_param('rtwdemo_pmsmfoc_local',...
       'ProdHWDeviceType', 'Texas Instruments->C2000',...
       'TemplateMakefile', 'ec_target.tmf',...
       'GenCodeOnly', 'off',...
       'SimulationMode', 'processor-in-the-loop (pil)')

You can specify collecting execution profiling information during PIL testing by logging the simulation
output values as the variable pilOut and logging the execution profiling information as the variable
executionProfile. These changes can be made graphically in the model's Configuration
Parameters dialog, or programmatically as shown below.

set_param('rtwdemo_pmsmfoc_local',...
    'CodeExecutionProfiling', 'on',...
    'CodeExecutionProfileVariable','executionProfile',...
    'CodeProfilingSaveOptions','AllData');
save_system('rtwdemo_pmsmfoc_local.slx')

The controller model is now ready to be run in PIL mode.

Test Behavior and Execution Time of Generated Code

In this section you will run the controller model in PIL mode and explore the behavioral and execution
profiling results. You will verify that the behavior of the compiled controller code matches the
reference simulation behavior, and then verify that the execution of the code meets timing
requirements.

You can run the model and plot the PIL simulation results. When you start the model for the first
time, Embedded Coder® will generate code for the algorithm, link the algorithm code with the serial
communication interface code, build the embedded application, download the application to the
board, and begin the on-target simulation. Note that during subsequent PIL simulations, code is only
regenerated if the model changes. Due to the overhead associated with the serial communication
interface, the PIL simulation may run slower than the model in normal mode.

The MATLAB® commands below are intentionally commented out as they require connection to
hardware and use of embedded development tools described previously. If you have the hardware
connected and embedded development tools installed, uncomment and execute these lines to run the
model, plot the results, and verify the behavior is numerically equivalent to the simulation running in
normal mode. Otherwise, continue reviewing this section to learn about PIL execution analysis
options.

% UNCOMMENT THE BELOW LINES TO RUN THE SIMULATION AND PLOT THE RESULTS
% if exist('slprj','dir'), rmdir('slprj','s'); end
% out = sim('rtwdemo_pmsmfoc_local')
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% pwm_compare_pil = out.logsout.getElement('pwm_compare').Values;
% rtwdemo_pmsmfoc_plotpwmcompare_pil(controller_mode, pwm_compare_pil, executionProfile)

The upper plot is the output of the controller, PWM Compare. Note that the outputs in PIL mode look
the same as the outputs of the simulation in normal mode shown in the section "Establish Reference
Behavior for Controller Model". You can subtract the outputs of normal mode simulation from the PIL
mode simulation output to verify that they are numerically equivalent:

% UNCOMMENT THE BELOW LINE TO VERIFY NUMERICAL EQUIVALENCE OF THE OUTPUTS
% pilErrorWithRespectToReference = sum(abs(pwm_compare_pil.Data - pwm_compare_pil.Data))

pilErrorWithRespectToReference =

   0     0     0

The lower plot is the amount of time spent executing the controller model at each simulation time
step. The "Stand By" state requires the least time. Small periodic spikes in execution time occur
because the controller is multi-rate and single tasking. The periodic spikes correspond to the time
required to run both the base rate and 5 millisecond rate code in the same task.

Since the controller must be executed at 25 kHz on the embedded processor, the algorithm must
complete its execution within 40 microseconds (minus additional headroom requirements by other
code, which may also be executing on the final application.) The profiling results indicate that the
algorithm will execute within the time allotted for this configuration of the embedded environment.

The generated code is now verified to provide numerically equivalent results and meets the execution
timing requirements for this test case.
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close_system('rtwdemo_pmsmfoc_local',0);
close_system('power_utile',0);

The MATLAB® preferences used in this PIL implementation are persistent between MATLAB®
sessions. If you want to remove these preferences, run the following commands.

rmpref('examplePilF28335');
rmexamplePilF28335hooks();

Conclusion

This example showed system level simulation and algorithmic code generation using a Field-Oriented
Control algorithm for a Permanent Magnet Synchronous Machine to explore functional behavior of
the controller algorithm. It also showed a general approach for target integration, functional testing,
and execution profiling for any embedded processor. Once the algorithm was behaviorally correct,
code was generated from the controller model, tested on the target processor and profiled. The
algorithm code is now verified and can be integrated with embedded software that interfaces with the
motor hardware for further testing.

See Also

Related Examples
• “SIL and PIL Simulations” on page 80-2
• “Choose a SIL or PIL Approach” on page 80-11
• “Create PIL Target Connectivity Configuration for Simulink” on page 80-39
• “Configure and Run SIL Simulation” on page 80-15
• “Code Execution Profiling with SIL and PIL” on page 74-2
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Check Configuration
Use the cgv.Config class to check model settings for a SIL or PIL simulation. You can review your
model configuration and determine the settings that you must change. By default, cgv.Config
changes configuration parameter values to the value that it recommends, but does not save the
model. Alternatively, you can:

• Change configuration parameter values to the values that cgv.Config recommends, and save the
model. Specify this approach using the SaveModel property.

• List the values that cgv.Config recommends for the configuration parameters, but not change
the configuration parameters or the model. Specify this approach using the ReportOnly property.

Note

• Execution in the target environment can require additional modifications to configuration
parameter values or the model.

• Do not use referenced configuration sets in models that you are changing using cgv.Config. If
the model uses a referenced configuration set, update the model with a copy of the configuration
set. Use the getRefConfigSet method of the Simulink.ConfigSetRef class.

• If you use cgv.Config on a model that executes a callback function, the callback function can
change configuration parameter values each time the model loads. The callback function can
revert changes that cgv.Config. For more information, see “Callbacks for Customized Model
Behavior”.

To verify that your model is configured for SIL or PIL:

1 Construct a cgv.Config object that changes the configuration parameter values without saving
the model.

2 Determine and change the configuration parameter values that the object recommends using the
configModel method.

3 Display a report of the changes that configModel makes.
4 Review the changes.
5 To apply the changes to your model, save the model.

See Also

Related Examples
• “Configure and Run SIL Simulation” on page 80-15
• “Verify Numerical Equivalence with CGV” on page 80-127
• “Verify Numerical Equivalence Between Two Modes of Execution of a Model” on page 80-128
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Verify Numerical Equivalence with CGV
Before verifying numerical equivalence:

• Configure your model for SIL or PIL simulation.
• Use the cgv.Config class of the CGV API to verify the model configuration for SIL or PIL

simulation.
• Configure your model for code generation. For more information, see “Configure Model for Code

Generation Objectives by Using Code Generation Advisor” on page 47-2.
• Save your model. If you modify a model without saving it, CGV can issue an error.

To verify numerical equivalence:

• Set up the tests for the first execution environment. For example, simulation.
• Use run to run the tests for the first execution environment.
• Set up the tests for the second execution environment. For example, top-model PIL.
• Use cgv.CGV.run to run the tests for the second execution environment.
• Use getOutputData to get the output data for each execution environment.
• Use getSavedSignals to display the signal names in the output data. (optional)
• Build a list of signal names for input to other cgv.CGV methods. (optional)
• Use createToleranceFile to create a file correlating tolerance information with output signal

names. (optional)
• Use compare to compare the output signals of the first and second execution environments for

numerical equivalence.

Note Simulink Test is a separate product that provides additional capabilities for SIL and PIL testing,
for example, test sequence construction and test management.

See Also

Related Examples
• “Configure and Run SIL Simulation” on page 80-15
• “Check Configuration” on page 80-126
• “Verify Numerical Equivalence Between Two Modes of Execution of a Model” on page 80-128
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Verify Numerical Equivalence Between Two Modes of Execution
of a Model

In this section...
“Configure the Model” on page 80-128
“Execute the Model” on page 80-128
“Compare All Output Signals” on page 80-129
“Compare Individual Output Signals” on page 80-130
“Plot Output Signals” on page 80-131

The following example describes configuring, executing, and comparing the results of the
rtwdemo_cgv model in normal and software-in-the-loop (SIL) simulation modes.

Configure the Model
The first task for verifying numerical equivalence is to check the configuration of your model.

1 Open the rtwdemo_cgv model.
cgvModel = 'rtwdemo_cgv';
load_system(cgvModel);

2 Save the model to a working directory.
save_system(cgvModel, fullfile(pwd, cgvModel));
close_system(cgvModel); % avoid original model shadowing saved model 

3 Use the cgv.Config to create a cgv.Config object. Specify parameters that check and modify
configuration parameter values and save the model for top-model SIL mode of execution.
cgvCfg = cgv.Config('rtwdemo_cgv', 'connectivity', 'sil', 'SaveModel', 'on');

4 Use the configModel method to review your model configuration and to change the settings to
configure your model for SIL. When 'connectivity' is set to 'sil', the system target file is
automatically set to 'ert.tlc'. If you specified the parameter/value pair, ('SaveModel',
'on') when you created the cgvCfg object, the cgv.Config.configModel method saves the
model.

Note CGV runs on models that are open. If you modify a model without saving it, CGV can issue
an error.

cgvCfg.configModel(); % Evaluate, change, and save your model for SIL

5 Display a report of the changes that cgv.Config.configModel makes to the model.
cgvCfg.displayReport(); % In this example, this reports no changes

Execute the Model
Use the CGV API to execute the model in two modes. The two modes in this example are normal mode
simulation and SIL mode. In each execution of the model, the CGV object for each mode captures the
output data and writes the data to a file.
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1 If you have not already done so, follow the steps described in “Configure the Model” on page 80-
128.

2 Create a cgv.CGV object that specifies the rtwdemo_cgv model in normal mode simulation.
cgvSim = cgv.CGV(cgvModel, 'connectivity', 'sim');

Note When the top model is set to normal simulation mode, the CGV API sets referenced models
in PIL mode to accelerator mode.

3 Provide the input file to the cgvSim object.
cgvSim.addInputData(1, [cgvModel '_data']);

4 Before execution of the model, specify the MATLAB files to execute or MAT-files to load. This step
is optional.
cgvSim.addPostLoadFiles({[cgvModel '_init.m']});

5 Specify a location where the object writes all output data and metadata files for execution. This
step is optional.
cgvSim.setOutputDir('cgv_output');

6 Execute the model.
result1 = cgvSim.run();

7 Get the output data associated with the input data.
outputDataSim = cgvSim.getOutputData(1);

8 For the next mode of execution, SIL, repeat steps 2–7.
cgvSil = cgv.CGV( cgvModel, 'Connectivity', 'sil');
cgvSil.addInputData(1, [cgvModel '_data']);
cgvSil.addPostLoadFiles({[cgvModel '_init.m']});
cgvSil.setOutputDir('cgv_output');
result2 = cgvSil.run();

Compare All Output Signals
After setting up and running the test, compare the outputs by doing the following:

1 If you have not already done so, configure and test the model, as described in “Configure the
Model” on page 80-128 and “Execute the Model” on page 80-128.

2 Test that the execution result of the model:
if ~result1 || ~result2
    error('Execution of model failed.');
end

3 Use the getOutputData method to get the output data from the cgv.CGV objects.
simData = cgvSim.getOutputData(1);
silData = cgvSil.getOutputData(1);

4 Display a list of signals by name using the getSavedSignals method.
cgvSim.getSavedSignals(simData);

5 Using the list of signals, build a list of signals in a cell array of character vectors. The signal list
can contain a number of signals.
signalList = {'simData.getElement(4).Values.Data'};

6 Use the createToleranceFile method to create a file, in this example, 'localtol',
correlating tolerance information with output signal names.
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toleranceList = {{'absolute', 0.5}};
cgv.CGV.createToleranceFile('localtol', signalList, toleranceList);

7 Compare the output data signals. By default, the compare method looks at all signals which have
a common name between both executions. If a tolerance file is present, cgv.CGV.compare uses
the associated tolerance for a specific signal during comparison; otherwise the tolerance is zero.
In this example, the 'Plot' parameter is set to 'mismatch'. Therefore, only mismatched
signals produce a plot.
[matchNames, ~, mismatchNames, ~] = ...
    cgv.CGV.compare(simData, silData, 'Plot', 'mismatch', ...
    'Tolerancefile', 'localtol');
fprintf( '%d Signals match, %d Signals mismatch\n', ...
    length(matchNames), length(mismatchNames));
disp('Mismatched Signal Names:');
disp(mismatchNames);

At the MATLAB command line, you see:
14 Signals match, 1 Signals mismatch
Mismatched Signal Names:
    'simData.getElement(4).Values.Data'

A plot results from the signal mismatch.

The lower plot displays the numeric difference between the results.

Compare Individual Output Signals
After setting up and running the test, compare the outputs of individual signals by doing the
following:
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1 If you have not already done so, configure and test the model, as described in “Configure the
Model” on page 80-128 and “Execute the Model” on page 80-128.

2 Use the getOutputData method to get the output data from the cgv.CGV objects.
simData = cgvSim.getOutputData(1);
silData = cgvSil.getOutputData(1);

3 Use the getSavedSignals method to display the output data signal names. Build a list of
specific signal names in a cell array of character vectors. The signal list can contain a number of
signals.
cgv.CGV.getSavedSignals(simData);

signalList = {'simData.getElement(3).Values.hi1.mid0.lo1.Data', ...
'simData.getElement(3).Values.hi1.mid0.lo2.Data', ...
'simData.getElement(2).Values.Data(:,3)'};

4 Use the specified signals as input to the compare method to compare the signals from separate
runs.
[matchNames, ~, mismatchNames, ~] = ...
    cgv.CGV.compare(simData, silData, 'Plot', 'mismatch', ...
    'signals', signalList);
fprintf( '%d Signals match, %d Signals mismatch\n', ...
    length(matchNames), length(mismatchNames));
if ~isempty(mismatchNames)
    disp( 'Mismatched Signal Names:');
    disp(mismatchNames);
end

At the MATLAB command line, the result is:
3 Signals match, 0 Signals mismatch

Plot Output Signals
After setting up and running the test, use the plot method to plot output signals.

1 If you have not already done so, configure and test the model, as described in “Configure the
Model” on page 80-128 and “Execute the Model” on page 80-128.

2 Use the getOutputData method to get the output data from the cgv.CGV objects.
simData = cgvSim.getOutputData(1);

3 Use the getSavedSignals method to display the output data signal names. Build a list of
specific signal names in a cell array of character vectors. The signal list can contain a number of
signals.
cgv.CGV.getSavedSignals(simData);
signalList = {'simData.getElement(2).Values.Data(:,1)'};

4 Use the specified signal list as input to the plot method to compare the signals from separate
runs.
[signalNames, signalFigures] = cgv.CGV.plot(simData, ...
     'Signals', signalList);
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See Also

Related Examples
• “Verify Numerical Equivalence with CGV” on page 80-127
• “Check Configuration” on page 80-126
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Numerical Consistency of Model and Generated Code
Simulation Results

In this section...
“Numerical Consistency” on page 81-2
“Numerical Consistency in Complex Systems” on page 81-2
“Reasons for Block-Level Numerical Differences” on page 81-4

Numerical Consistency
In the Model-Based Design workflow, you use MathWorks products to generate code for numerical
applications that employ fixed-point and floating-point arithmetic.

• To develop models, you use MATLAB, Simulink, and Stateflow.
• To generate source code, you use Simulink Coder and Embedded Coder.
• To test numerical equivalence between your model and generated code, you compare model and

generated code simulation results. For example, normal mode simulation results compared with
software-in-the-loop (SIL) simulation results.

The results from the model and generated code simulations are numerically consistent if:

• In fixed-point applications, the results agree in a bit-wise comparison.
• In floating-point applications, the results agree with an error tolerance that you specify.

Use the Simulation Data Inspector to compare results. To determine whether discrepancies exist or
are significant, you can specify absolute and relative tolerance values:

• For fixed-point applications, you can specify an absolute tolerance of zero.
• For floating-point applications, you can specify tolerance with respect to a reference value or

signal. The choice of reference depends on your application. Consider these examples:

• An algorithm that solves a linear algebraic equation by iterative, feed-forward error
calculations. You can specify tolerance with respect to eps.

• A Proportional-Integral-Derivative (PID) controller for a closed-loop system. For transient
behavior, you can specify tolerance with criteria from a standard. For steady-state behavior,
you can specify tolerance with reference to the PID controller characteristics.

Programmatically, you can specify absolute and relative tolerance values through the absTol and
relTol properties of the Simulink.sdi.Signal object.

Numerical Consistency in Complex Systems
For complex systems, numerical differences between model and generated code simulations can be a
result of block-level differences propagating through the system. If you observe numerical differences
at the system level:

1 Identify blocks for which block-level numerical differences exceed the error tolerance.
2 Investigate each identified block.
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Consider the following plant-controller model.

• T produces reference or test signals.
• C is the controller component. The controller output is the plant input. C can be a Model block

that comprises multiple Model blocks.
• P is the plant component. The plant output is subtracted from the reference signal to produce the

controller input.

To test numerical equivalence between the model controller and the generated code version:

1 Run the model in normal mode, and, using the Simulation Data Inspector, record the output of C.
2 Specify SIL mode for C. Rerun the simulation, recording the output of C.
3 Using the Simulation Data Inspector, compare normal and SIL mode outputs with reference to

your specified error tolerance.

If the Simulation Data Inspector comparison indicates a match, the model and generated code results
are numerically consistent.

If the normal and SIL mode outputs do not match:

1 Within C, enable signal logging for block outputs.
2 Run the model in normal mode.
3 Rerun the simulation with C in SIL mode.
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4 Using the Simulation Data Inspector, compare the logged output signals with reference to your
specified error tolerance. See “Compare Simulation Data”.

5 Identify blocks for which normal and SIL mode output differences exceed the error tolerance.
6 Analyze each identified block and look for the cause. For example, the generated code might use

a different math library than MATLAB.

Note If the comparison of a large number of signals is required, you can automate the workflow with
Simulink Test. See “SIL Verification for a Subsystem” (Simulink Test).

Reasons for Block-Level Numerical Differences
In fixed-point and floating-point application development, there are factors that can affect numerical
agreement between block-level results from model and generated code simulations.

Some factors can affect both fixed-point and floating-point applications. For example, the use of:

• Code generation optimization.
• Custom code.
• Code replacement library entries whose results differ from MATLAB results.
• Code replacement libraries that implement different algorithms.

Other factors affect only floating-point applications. For example:

• Numerical soundness of algorithm.
• Algorithm sensitivity to input.
• Closed loop and open loop behavior.

References
[1] IEEE Standard on Transitions, Pulses, and Related Waveforms, IEEE Standard 181, 2003, pp. 15–

17.

See Also
eps

Related Examples
• “Inspect and Analyze Simulation Results”
• “SIL Verification for a Subsystem” (Simulink Test)
• “Differences Between Generated Code and MATLAB Code”
• “Code Replacement”
• “Types of In-the-Loop Testing in the V-Model”
• MATLAB Function
• “SIL and PIL Limitations” on page 80-74
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Software-in-the-Loop Execution for
MATLAB Coder

• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution”
on page 82-2

• “Software-in-the-Loop Execution with the MATLAB Coder App” on page 82-4
• “Software-in-the-Loop Execution From Command Line” on page 82-6
• “Debug Generated Code During SIL Execution” on page 82-9
• “Create PIL Target Connectivity Configuration for MATLAB” on page 82-11
• “Host-Target Communication for MATLAB PIL Execution” on page 82-14
• “Specify Hardware Timer” on page 82-16
• “Custom Toolchain Directives Required for Code Execution Profiling” on page 82-19
• “Processor-in-the-Loop Execution with the MATLAB Coder App” on page 82-20
• “Processor-in-the-Loop Execution From Command Line” on page 82-22
• “Verification of Code Generation Assumptions” on page 82-26
• “SIL/PIL Execution Support and Limitations” on page 82-27
• “Speed Up SIL/PIL Execution by Disabling Constant Input Checking and Global Data

Synchronization” on page 82-29
• “SIL and PIL Verification for Deployment on Raspberry Pi” on page 82-30
• “Software-in-the-loop Execution For MATLAB Function with Multiple Signatures” on page 82-36

82



Code Verification Through Software-in-the-Loop and Processor-
in-the-Loop Execution

MATLAB Coder supports software-in-the-loop (SIL) and processor-in-the-loop (PIL) execution, which
enables you to verify production-ready source code and compiled object code. With these execution
modes, you can reuse test vectors developed for your MATLAB functions to verify the numerical
behavior of library code.

In SIL execution, through a MATLAB SIL interface, the software compiles and runs library code on
your development computer. In PIL execution, through a MATLAB PIL interface, the software cross-
compiles and runs production object code on a target processor or an equivalent instruction set
simulator. Before you run a PIL execution, you must set up a PIL connectivity configuration for your
target.

The workflow for generating and verifying code is:

1 Set up MATLAB Coder.
2 Fix errors detected at design time.
3 Generate MEX function.
4 Test MEX function.
5 Generate C/C++ library code.
6 Verify generated C/C++ code through SIL or PIL execution — requires Embedded Coder license.

In step 4, you verify code that is generated for execution within MATLAB. However, this code is
different from the standalone code generated for libraries. In step 6, with an Embedded Coder
license, you use SIL or PIL execution to verify the standalone code.

For more information, use the following table.

Feature See
SIL execution • “Software-in-the-Loop Execution with the

MATLAB Coder App” on page 82-4
• “Software-in-the-Loop Execution From

Command Line” on page 82-6
PIL target connectivity configuration • “Create PIL Target Connectivity Configuration

for MATLAB” on page 82-11
• “Host-Target Communication for MATLAB PIL

Execution” on page 82-14
• “Processor-in-the-Loop Execution From

Command Line” on page 82-22
PIL execution • “Processor-in-the-Loop Execution with the

MATLAB Coder App” on page 82-20
• “Processor-in-the-Loop Execution From

Command Line” on page 82-22
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Feature See
Code generation, MEX functions, and libraries • “MATLAB Code Analysis”

• “Generating Code”
• “Deployment”
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Software-in-the-Loop Execution with the MATLAB Coder App
Use software-in-the-loop (SIL) execution to verify the numerical behavior of the generated C/C++
code with reference to your original MATLAB functions.

1 To open the MATLAB Coder app, on the MATLAB Toolstrip Apps tab, under Code Generation,
click the app icon.

2
To open your project, click , and then click Open existing project. Select the project.
For example, kalman_filter01.prj.

3 On the Generate Code page, click the Generate arrow .
4 In the Generate dialog box:

a Set Build type to Static Library or Dynamic Library.
b In the Output file name field, use the default value. For example, kalman01.
c Specify Language.
d Clear the Generate code only check box.
e In the Hardware Board field, use the default value (MATLAB Host Computer).

You do not have to specify the Toolchain setting. By default, the MATLAB Coder app locates an
installed toolchain.

5 To generate the C or C++ code, click Generate.
6 Click Verify Code.
7 In the command field, specify the test file that calls the original MATLAB functions, for example,

test01_ui.m.
8 If required, select the Enable source-level debugging for SIL check box.
9 To start the SIL execution, click Run Generated Code.

The MATLAB Coder app:

• Generates a standalone library, for example, codegen\lib\kalman01.
• Generates SIL interface code, for example, codegen\lib\kalman01\sil.
• Runs the test file, replacing calls to the MATLAB function with calls to the generated code in

the library.
• Displays messages from the SIL execution in the Test Output tab.

10 Verify that the results from the SIL execution match the results from the original MATLAB
functions.

11 To terminate the SIL execution process, click Stop SIL Verification. Alternatively, on the Test
Output tab, click the link that follows To terminate execution.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
execution. To allow the execution, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.
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See Also

Related Examples
• “Generate C Code by Using the MATLAB Coder App”
• “Software-in-the-Loop Execution From Command Line” on page 82-6
• “Debug Generated Code During SIL Execution” on page 82-9
• “Generate Execution Time Profile” on page 75-3

More About
• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution” on page

82-2
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Software-in-the-Loop Execution From Command Line
Use software-in-the-loop (SIL) execution to verify the numerical behavior of the generated C/C++
code with reference to your original MATLAB functions.

To set up and start a SIL execution from the command line:

1 Create a coder.EmbeddedCodeConfig object.
2 Configure the object for SIL.
3 Use the codegen function to generate library code for your MATLAB function and the SIL

interface.
4 Use the coder.runTest function to run the test file for your original MATLAB function.

To terminate the SIL execution, use the clear function_sil or clear mex command.

The following example shows how you can set up and run a SIL execution from the command line.

SIL Execution of Code Generated for a Kalman Estimator
1 Copy MATLAB code for Kalman estimator

From docroot\toolbox\coder\examples\kalman, copy the following files to your working
folder:

• kalman01.m — MATLAB function for the Kalman estimator
• test01_ui.m — MATLAB file to test kalman01.m
• plot_trajectory.m — File that plots actual target trajectory and Kalman estimator output
• position.mat — Input data

src_dir = ...
    fullfile(docroot,'toolbox','coder','examples','kalman');

copyfile(fullfile(src_dir,'kalman01.m'), '.')
copyfile(fullfile(src_dir,'test01_ui.m'), '.')
copyfile(fullfile(src_dir,'plot_trajectory.m'), '.')
copyfile(fullfile(src_dir,'position.mat'), '.')

For a description of the Kalman estimator in this example, see “Generate C Code at the
Command Line”.

2 Configure SIL execution

a From your working folder, create a coder.EmbeddedCodeConfig object.
config = coder.config('lib');
config.GenerateReport = true; % Optional, documents code in HTML report

b Configure the object for SIL.

config.VerificationMode = 'SIL';

% Check that production hardware setting is the default
% i.e. 'Generic->MATLAB Host Computer'
disp(config.HardwareImplementation.ProdHWDeviceType); 
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c If required, enable the Microsoft Visual Studio debugger for SIL execution:

config.SILDebugging = true;
3 Generate code and run SIL execution

Generate library code for the kalman01 MATLAB function and the SIL interface, and run the
MATLAB test file, test01_ui. The test file uses kalman01_sil, the generated SIL interface for
kalman01.

codegen -config config -args {zeros(2,1)} kalman01 -test test01_ui

The software creates the following output folders:

• codegen\lib\kalman01 — Standalone code for kalman01.
• codegen\lib\kalman01\sil — SIL interface code for kalman01.

Verify that the output of this run matches the output from the original kalman01.m function.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
execution. To allow the execution, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

4 Debug code during SIL execution

If you enable the Microsoft Visual Studio debugger, then running the test file opens the Microsoft
Visual Studio IDE with debugger breakpoints at the start of the kalman01_initialize and
kalman01 functions.

You can use the debugger features to observe code behavior. For example, you can step through
code and examine variables.

To end the debugging session:

a Remove all breakpoints.
b Click the Continue button (F5).

The SIL execution runs to completion.
5 Terminate SIL execution

Terminate the SIL execution process.

clear kalman01_sil;

You can also use the command clear mex, which clears MEX functions from memory.

Note Suppose that the MATLAB current working directory (the folder that pwd displays) is a UNC
path (for example, \\server\a\b\c) on a Windows platform. If you launch a SIL executable from
this path, the location where the SIL executable is launched can be unpredictable and different from
the MATLAB current working directory (for example, C:\Windows).

To fix this issue, use a mapped network drive for the UNC path as your MATLAB current working
directory.
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See Also

Related Examples
• “Generate C Code by Using the MATLAB Coder App”
• “Software-in-the-Loop Execution with the MATLAB Coder App” on page 82-4
• “Debug Generated Code During SIL Execution” on page 82-9
• “Generate Execution Time Profile” on page 75-3

More About
• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution” on page

82-2
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Debug Generated Code During SIL Execution
If a SIL execution fails or you notice differences between the outputs of your original functions and
the generated code, you can rerun the SIL execution with a debugger enabled. By inserting
breakpoints, you can observe the behavior of code sections, which might help you to understand the
cause of the problem.

For a SIL execution failure, you can also view information from the standard output and standard
error streams in the MATLAB Command Window. For example:

• Output from printf statements in your code.
• If you enable run-time error detection, messages sent to stderr.
• Some low-level system messages.

Note During a SIL execution, the SIL application redirects the stdout and stderr streams. When
the application terminates, the MATLAB Command Window displays the information from the
redirected streams. The SIL application also provides a basic signal handler, which captures the
POSIX signals SIGFPE, SIGILL, SIGABRT, and SIGSEV. For this signal handler, the SIL application
includes the file signal.h.

A SIL execution supports the following debuggers:

• On Windows, Microsoft Visual Studio debugger.
• On Linux, GNU Data Display Debugger (DDD).
• On macOS, LLDB Debugger (LLBD).

Note You can perform SIL debugging only if your Microsoft Visual C++ or GNU GCC compiler is
supported by the MATLAB product family. For more information, see supported compilers.

To run a SIL execution with debugging enabled:

1 On the Generate Code page, click Verify Code.
2 Select the Enable source-level debugging for SIL check box.
3 Click Run Generated Code.

On a Windows computer, your user_fn.c or user_fn.cpp file opens in the Microsoft Visual Studio
IDE with debugger breakpoints at the start of the user_fn_initialize and user_fn functions.

 Debug Generated Code During SIL Execution

82-9

https://www.mathworks.com/support/compilers.html


You can now use the debugger features to observe code behavior. For example, you can step through
code and examine variables.

To end the debugging session:

1 Remove all breakpoints.
2 Click the Continue button (F5).

The SIL execution runs to completion.
3 To terminate the SIL execution process, on the Test Output tab, click the link that follows To

terminate execution, for example, clear kalman01_sil.

The Microsoft Visual Studio IDE closes automatically.

Note If you select Debug > Stop Debugging, the SIL execution times out with the following error
message:

Communications error: failed to send data to the target. There might be 
multiple reasons for this failure.

...

...

See Also

Related Examples
• “Software-in-the-Loop Execution with the MATLAB Coder App” on page 82-4
• “Software-in-the-Loop Execution From Command Line” on page 82-6
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Create PIL Target Connectivity Configuration for MATLAB
In this section...
“Target Connectivity Configurations for PIL” on page 82-11
“Create a Target Connectivity API Implementation” on page 82-11
“Register Target Connectivity Configuration” on page 82-13
“Verify Target Connectivity Configuration” on page 82-13

Target Connectivity Configurations for PIL
Use target connectivity configurations and the target connectivity API to customize processor-in-the-
loop (PIL) execution for your target environments.

Through a target connectivity configuration, you specify:

• A target connectivity configuration name for a target connectivity API implementation.
• Settings that define compatible MATLAB code. For example, the code that is generated for a

particular hardware implementation.

A PIL execution requires a target connectivity PIL API implementation that integrates third-party
tools for:

• Building the PIL application that runs on the target hardware
• Downloading, starting, and stopping the application on the target
• Communicating between MATLAB and the target

You can have many different connectivity configurations for PIL execution. Register a connectivity
configuration with MATLAB by creating an rtwTargetInfo.m file and placing it on the MATLAB
search path.

In a PIL execution, the software determines which of the available connectivity configurations to use.
The software looks for a connectivity configuration that is compatible with the MATLAB code under
test. If the software finds multiple or no compatible connectivity configurations, the software
generates an error message with information about resolving the problem.

Create a Target Connectivity API Implementation
This diagram shows the components of the PIL target connectivity API.
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You must provide implementations of the three API components:

• Build API — Specify a toolchain approach for building generated code.
• Launcher API — Control how MATLAB starts and stops the PIL executable.
• Communications API — Customize connectivity between MATLAB and the PIL target. Embedded

Coder provides host-side support for TCP/IP and serial communications, which you can adapt for
other protocols.

These steps outline how you create a target connectivity API implementation. The example code
shown in the steps is taken from the ConnectivityConfig.m file used in “Processor-in-the-Loop
Execution From Command Line” on page 82-22.

1 Create a subclass of rtw.connectivity.Config.

ConnectivityConfig < rtw.connectivity.Config

2 In the subclass:

• Instantiate rtw.connectivity.MakefileBuilder, which configures the build process.

builder = rtw.connectivity.MakefileBuilder(componentArgs, ...
                targetApplicationFramework, ...
                exeExtension);

• Create a subclass of rtw.connectivity.Launcher, which downloads and executes the
application using a third-party tool.

launcher = mypil.Launcher(componentArgs, builder);

3 Configure your rtiostream API implementation of the host-target communications on page 82-
14 channel.

• For the target side, you must provide the driver code for communications, for example, code
for TCP/IP or serial communications. To integrate this code into the build process, create a
subclass of rtw.pil.RtIOStreamApplicationFramework.
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• For the host side, you can use a supplied library for TCP/IP or serial communications.
Instantiate rtw.connectivity.RtIOStreamHostCommunicator, which loads and
initializes the library that you specify.
hostCommunicator = rtw.connectivity.RtIOStreamHostCommunicator(...
                        componentArgs, ...
                        launcher, ...
                        rtiostreamLib);

4 If you require execution-time profiling of generated code, create a timer object that provides
details of the hardware-specific timer and associated source files. See “Specify Hardware Timer”
on page 82-16.

Register Target Connectivity Configuration
To register a target connectivity API implementation as a target connectivity configuration in
MATLAB:

1 Create or update an rtwTargetInfo.m file. In this file:

• Create a target connectivity configuration object that specifies, for example, the configuration
name for a target connectivity API implementation and compatible MATLAB code.

• Invoke registerTargetInfo.
2 Add the folder containing rtwTargetInfo.m to the search path and refresh the MATLAB Coder

library registration information.

For more information, see rtw.connectivity.ConfigRegistry.

Verify Target Connectivity Configuration
To verify your target connectivity configuration early on and independently of your algorithm
development and code generation, use the piltest function. With the function, you can run a suite
of tests. The function:

• Runs the MATLAB function and performs PIL executions.
• Compares results and produces errors if it detects differences.

For an example, see “PIL Execution of Code Generated for a Kalman Estimator” on page 82-22.

See Also
piltest | rtw.connectivity.Config | rtw.connectivity.ConfigRegistry |
rtw.connectivity.Launcher | rtw.connectivity.MakefileBuilder |
rtw.connectivity.RtIOStreamHostCommunicator |
rtw.pil.RtIOStreamApplicationFramework

Related Examples
• “Processor-in-the-Loop Execution From Command Line” on page 82-22
• “Design Subclass Constructors”
• “Host-Target Communication for MATLAB PIL Execution” on page 82-14
• “Specify Hardware Timer” on page 82-16
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Host-Target Communication for MATLAB PIL Execution

In this section...
“Communications rtiostream API” on page 82-14
“Synchronize Host and Target” on page 82-15
“Test an rtiostream Driver” on page 82-15

This section provides information about using the rtiostream API for communication between your
development computer and target hardware during PIL execution.

Communications rtiostream API
The rtiostream API supports communications for the target connectivity API. Use the rtiostream
API to implement a communication channel that enables data exchange between different processes.

PIL verification requires a host-target communications channel. This communications channel
comprises driver code that runs on the host and target. The rtiostream API defines the signature of
target-side and host-side functions that must be implemented by this driver code.

The API is independent of the physical layer that sends the data. Possible physical layers include
RS232, Ethernet, or Controller Area Network (CAN).

A full rtiostream implementation requires both host-side and target-side drivers. Code generation
software includes host-side drivers for the default TCP/IP implementation as well as a version for
serial communications. To use:

• The TCP/IP rtiostream communications channel, you must provide, or obtain from a third party,
target-specific TCP/IP device drivers.

• The serial communications channel, you must provide, or obtain from a third party, target-specific
serial device drivers.

For other communication channels and platforms, the code generation software does not provide
default implementations. You must provide both the host-side and the target-side drivers.

The rtiostream API comprises the following functions:

• rtIOStreamOpen
• rtIOStreamSend
• rtIOStreamRecv
• rtIOStreamClose

For information about:

• Using rtiostream functions in a connectivity implementation, see “Create a Target Connectivity
API Implementation” on page 82-11.

• Testing the rtiostream shared library methods from MATLAB code, see rtiostream_wrapper.
• Debugging and verifying the behavior of custom rtiostream interface implementations, see

“Test an rtiostream Driver” on page 82-15 and rtiostreamtest.
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Synchronize Host and Target
If you use the rtiostream API to implement the communications channel, the host and target must
be synchronized, which prevents MATLAB from transmitting and receiving data before the target
application is fully initialized.

To synchronize the host and target for TCP/IP rtiostream implementations, use the
setInitCommsTimeout method from rtw.connectivity.RtIOStreamHostCommunicator. This
approach works well for connection-oriented TCP/IP rtiostream implementations because MATLAB
automatically waits until the target server is running.

With other rtiostream implementations, for example, serial, the MATLAB side of the rtiostream
connection opens without waiting for the target to be fully initialized. In this case, you must make
your Launcher implementation wait until the target application is fully initialized. Use one of the
following approaches to synchronize your host and target:

• Add a pause at the end of the Launcher implementation that makes the Launcher wait until
target initialization is complete.

• In the Launcher implementation, use third-party downloader or debugger APIs that wait until
target initialization is complete.

• Implement a handshaking mechanism in the Launcher / rtiostream implementation that
confirms completion of target initialization.

Test an rtiostream Driver
Use a test suite to debug and verify the behavior of custom rtiostream interface implementations.

The test suite can help you to:

• Reduce the time required for integrating custom hardware that does not have built-in
rtiostream support.

• Reduce the time required for testing custom rtiostream drivers.
• Analyze the performance of custom rtiostream drivers.

The test suite consists of two parts. One part is an application that runs on the target hardware. The
other part runs in MATLAB. For details, see rtiostreamtest.

See Also
rtIOStreamClose | rtIOStreamOpen | rtIOStreamRecv | rtIOStreamSend |
rtiostream_wrapper | rtiostreamtest |
rtw.connectivity.RtIOStreamHostCommunicator

Related Examples
• “Create PIL Target Connectivity Configuration for MATLAB” on page 82-11

 Host-Target Communication for MATLAB PIL Execution

82-15



Specify Hardware Timer
For processor-in-the-loop (PIL) code execution profiling, you must create a timer object that provides
details of the hardware-specific timer and associated source files. You can use the Code
Replacement Tool or the code replacement library API to specify this hardware-specific timer.

To specify the timer with the Code Replacement Tool:

1 Open the Code Replacement Tool. In the Command Window, enter crtool.
2 Create a new code replacement table. Select File > New table.
3 Create a new function entry. Under Tables List, right-click the new table. Then, from the

context-menu, select New entry > Function.
4 In the middle view, select the new unnamed function.
5 On the Mapping Information pane:

a From the Function drop-down list, select code_profile_read_timer.
b Specify the count direction for your timer. For example, from the Count direction drop-

down list, select Up.
c In the Ticks per second field, specify the number of ticks per second for your timer, for

example, 1e+09.

The default value is 0. In this case, the software reports time measurements in terms of
ticks, not seconds.

d In the Conceptual function section, from the Data type list, select uint8, uint16,
uint32, or uint64.

e In the Function prototype section, in the Name field, specify a replacement function name,
for example, MyTimer.

f Click Apply.
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g To validate the function entry, click Validate entry.
6 On the Build Information pane, specify the required build information. See Specify build

information in “Define Code Replacement Library Optimizations” on page 67-36.
7 Save the table (Ctrl+S). When you save the table for the first time, use the Save As dialog box to

specify the file name and location.

You must save the table in a location that is on the MATLAB search path. For example, you can
save this file in the folder for your subclass of rtw.connectivity.Config.

The software stores your timer information as a code replacement library table.
8 Assuming you save the table as MyCrlTable.m, in your subclass of

rtw.connectivity.Config, add the following line:

setTimer(this, MyCrlTable)

See Also

Related Examples
• “Create a Target Connectivity API Implementation” on page 82-11
• “Generate Execution Time Profile” on page 75-3
• “Define Code Replacement Library Optimizations” on page 67-36

More About
• “What Is Code Replacement?” on page 55-2
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• “What Is Code Replacement Customization?” on page 67-3
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Custom Toolchain Directives Required for Code Execution
Profiling

If you use a custom toolchain for building a processor-in-the-loop (PIL) target application that
supports code execution profiling, in the toolchain definition file, you must provide these compiler
directives:

• CompileFlag — Specify the flag that C or C++ compiler uses to compile source files without
linking. For example, if the compiler in the toolchain is GNU C or C++, set the directive to -c.

• PreprocessFile — Specify the flag that C or C++ compiler uses to preprocess the source files
without running other compiler stages. For example, if the compiler in the toolchain is GNU C or C
++, set the directive to -E.

This section from a toolchain definition file example shows how you can use the setDirective
method to provide the directives.

tc = coder.make.ToolchainInfo('BuildArtifact','nmake makefile');
tc.Name ='My Toolchain Name';
tc.Platform ='win64';
tc.SupportedVersion ='14';
...
% ------------------------------
% C Compiler
% ------------------------------
tool = tc.getBuildTool('C Compiler');
tool.setName('My C Compiler');
...
tool.setDirective('CompileFlag','-c');
tool.setDirective('PreprocessFile','-E');
...

See Also

More About
• “Custom Toolchain Registration”
• “Add Custom Toolchains to MATLAB® Coder™ Build Process”
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Processor-in-the-Loop Execution with the MATLAB Coder App
Use processor-in-the-loop (PIL) execution to verify the numerical behavior of cross-compiled object
code with reference to your original MATLAB functions.

Before you run a PIL execution, you must define a target connectivity configuration. In “Processor-in-
the-Loop Execution From Command Line” on page 82-22, steps 1 and 2 of the example PIL
Execution of Code Generated for a Kalman Estimator show how you can set up and register a
connectivity configuration for PIL execution on your development computer.

1 To open the MATLAB Coder app, on the MATLAB Toolstrip Apps tab, under Code Generation,
click the app icon.

2
To open your project, click , and then click Open existing project. Select the project.
For example, kalman_filter.prj.

3 On the Generate Code page, click the Generate arrow .
4 In the Generate dialog box:

a Set Build type to Static Library or Dynamic Library.
b In the Output file name field, use the default value. For example, kalman01.
c Clear the Generate code only check box.
d From the Hardware Board drop-down list, select None - Select device below.
e In the Device fields, specify vendor and type. These settings must match the target

hardware settings in the rtwTargetInfo.m file of your target connectivity configuration.
For host-based PIL, select settings that match your host computer. For example:

• For a Windows 64-bit system, set Device vendor to Intel and Device type to x86-64
(Windows64). In addition, set Enable long long to Yes.

• For a Linux 64-bit system, set Device vendor to Intel and Device type to x86-64
(Linux 64).

• For a Mac OS X system, set Device vendor to Intel and Device type to x86-64 (Mac
OS X).

You do not have to specify the Toolchain setting. By default, the MATLAB Coder app locates an
installed toolchain.

5 To generate the C or C++ code, click Generate.
6 Click Verify Code.
7 In the command field, specify the test file that calls the original MATLAB functions, for example,

test01_ui.m.
8 To start the PIL execution, click Run Generated Code.

The MATLAB Coder app:

• Generates a standalone library, for example, codegen\lib\kalman01.
• Generates PIL interface code, for example, codegen\lib\kalman01\pil.
• Runs the test file, replacing calls to the MATLAB function with calls to the generated code in

the library.
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• Displays messages from the PIL execution in the Test Output tab.
9 Verify that the results from the PIL execution match the results from the original MATLAB

functions.
10 To terminate the PIL execution process, click Stop PIL Verification. Alternatively, on the Test

Output tab, click the link that follows To terminate execution.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
execution. To allow the execution, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

See Also

Related Examples
• “Generate C Code by Using the MATLAB Coder App”
• “Processor-in-the-Loop Execution From Command Line” on page 82-22
• “Generate Execution Time Profile” on page 75-3

More About
• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution” on page

82-2
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Processor-in-the-Loop Execution From Command Line
Use processor-in-the-loop (PIL) execution to verify code that you intend to deploy in production.

To set up and start a PIL execution from the command line:

1 Create, register, and verify your target connectivity configuration.
2 Create a coder.EmbeddedCodeConfig object.
3 Configure the object for PIL.
4 Use the codegen function to generate library code for your MATLAB function and the PIL

interface.
5 Use the coder.runTest function to run the test file for your original MATLAB function.

To terminate the PIL execution, use the clear function_pil or clear mex command.

The following example shows how you can use line commands to set up and run a PIL execution on
your development computer.

PIL Execution of Code Generated for a Kalman Estimator
1 Create a target connectivity API implementation

a In your current working folder, make a local copy of the connectivity classes.
src_dir = ...
    fullfile(matlabroot,'toolbox','coder','simulinkcoder','+coder','+mypil');
if exist(fullfile('.','+mypil'),'dir')
    rmdir('+mypil','s')
end
mkdir +mypil
copyfile(fullfile(src_dir,'Launcher.m'), '+mypil');
copyfile(fullfile(src_dir,'TargetApplicationFramework.m'), '+mypil');
copyfile(fullfile(src_dir,'ConnectivityConfig.m'), '+mypil');

b Make the copied files writable.
fileattrib(fullfile('+mypil', '*'),'+w');

c Update the package name to reflect the new location of the files.
coder.mypil.Utils.UpdateClassName(...
    './+mypil/ConnectivityConfig.m',...
    'coder.mypil',...
    'mypil');

d Check that you now have a folder +mypil in the current folder, which includes three files,
Launcher.m, TargetApplicationFramework.m, and ConnectivityConfig.m.
dir './+mypil'

e Review the code that starts the PIL application. The mypil.Launcher class configures a
tool for starting the PIL executable. Open this class in the editor.
edit(which('mypil.Launcher'))

Review the content of this file. For example, consider the setArgString method. This
method allows additional command line parameters to be supplied to the application. These
parameters can include a TCP/IP port number. For an embedded processor implementation,
you might have to hard code these settings.

f The class mypil.ConnectivityConfig configures target connectivity.
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edit(which('mypil.ConnectivityConfig'))

Review the content of this file. For example:

• The creation of an instance of rtw.connectivity.RtIOStreamHostCommunicator
that configures the host side of the TCP/IP communications channel.

• A call to the setArgString method of Launcher that configures the target side of the
TCP/IP communications channel.

• A call to setTimer that configures a timer for execution time measurement. To define
your own target-specific timer for execution time profiling, you must use the Code
Replacement Library to specify a replacement for the function
code_profile_read_timer.

g Review the target-side communication drivers.
rtiostreamtcpip_dir=fullfile(matlabroot,'toolbox','coder','rtiostream','src',...
    'rtiostreamtcpip');
edit(fullfile(rtiostreamtcpip_dir,'rtiostream_tcpip.c'))

Scroll down to the end of this file. The file contains a TCP/IP implementation of the functions
rtIOStreamOpen, rtIOStreamSend, andrtIOStreamRecv. These functions are required
for target communication with the host. For each of these functions, you must provide an
implementation that is specific to your target hardware and communication channel.

The mypil.TargetApplicationFramework class adds target-side communication drivers
to the connectivity configuration.
edit(which('mypil.TargetApplicationFramework'))

The file specifies additional files to include in the build.
2 Register a target connectivity configuration

Use an rtwTargetInfo.m file to:

• Create a target connectivity configuration object.
• Invoke registerTargetInfo, which registers the target connectivity configuration.

The target connectivity configuration object specifies, for example:

• The configuration name and associated API implementation. See
rtw.connectivity.ConfigRegistry.

• A toolchain for your target hardware. This example assumes that the target hardware is your
host computer, and uses the toolchain supplied for host-based PIL verification. For
information about toolchains, see “Custom Toolchain Registration”.

a Insert the following code into your rtwTargetInfo.m file, and save the file in the current
working folder or in a folder that is on the MATLAB search path:
function rtwTargetInfo(tr)
% Register PIL connectivity config: mypil.ConnectivityConfig

tr.registerTargetInfo(@loc_createConfig);

% local function
function config = loc_createConfig

% Create object for connectivity configuration
config = rtw.connectivity.ConfigRegistry;
% Assign connectivity configuration name
config.ConfigName = 'My PIL Example';
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% Associate the connectivity configuration with the connectivity
% API implementation
config.ConfigClass = 'mypil.ConnectivityConfig';

% Specify toolchains for host-based PIL
config.Toolchain =  rtw.connectivity.Utils.getHostToolchainNames;

% Through the HardwareBoard and TargetHWDeviceType properties,
% define compatible code for the target connectivity configuration
config.HardwareBoard = {};  % Any hardware board
config.TargetHWDeviceType = {'Generic->32-bit x86 compatible' ...
                             'Generic->Custom' ...
                             'Intel->x86-64 (Windows64)', ...
                             'Intel->x86-64 (Mac OS X)', ...
                             'Intel->x86-64 (Linux 64)'};

b Refresh the MATLAB Coder library registration information.
RTW.TargetRegistry.getInstance('reset');

3 Verify target connectivity configuration

Use the supplied piltest function to verify your target connectivity configuration.

a Create a coder.EmbeddedCodeConfig object for verifying the target connectivity
configuration.
configVerify = coder.config('lib');

b Specify the manufacturer and test hardware type. For example, PIL execution on a 64-bit
Windows development computer requires:
configVerify.HardwareImplementation.TargetHWDeviceType =... 
   'Intel->x86-64 (Windows64)'; 
configVerify.HardwareImplementation.ProdLongLongMode = true;

c Run piltest.
piltest(configVerify, 'ConfigParam', {'ProdLongLongMode'} )

4 Copy MATLAB code for Kalman estimator

Copy the MATLAB code to your working folder.
src_dir = ...
    fullfile(docroot,'toolbox','coder','examples','kalman');

copyfile(fullfile(src_dir,'kalman01.m'), '.')
copyfile(fullfile(src_dir,'test01_ui.m'), '.')
copyfile(fullfile(src_dir,'plot_trajectory.m'), '.')
copyfile(fullfile(src_dir,'position.mat'), '.')

For a description of the Kalman estimator in this example, see “Generate C Code at the
Command Line”.

5 Configure the PIL execution

a Create a coder.EmbeddedCodeConfig object.
config = coder.config('lib');

b Configure the object for PIL.
config.VerificationMode = 'PIL';

c Specify production hardware, which must match one of the test hardware settings in
rtwTargetInfo.m. For PIL execution on your development computer, specify settings that
match the computer. For example, if your computer is a Windows 64-bit system, specify:
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config.HardwareImplementation.ProdHWDeviceType =...
   'Intel->x86-64 (Windows64)';
config.HardwareImplementation.ProdLongLongMode = true;

For a Linux 64-bit system, set ProdHWDeviceType to 'Intel->x86-64 (Linux 64)'.

For a Mac OS X system, set ProdHWDeviceType to 'Intel->x86-64 (Mac OS X)'.
6 Generate code and run PIL execution

Generate library code for the kalman01 MATLAB function and the PIL interface, and run the
MATLAB test file, test01_ui. The test file uses kalman01_pil, the generated PIL interface for
kalman01.

codegen -config config -args {zeros(2,1)} kalman01 -test test01_ui

The software creates the following output folders:

• codegen\lib\kalman01 — Standalone code for kalman01.
• codegen\lib\kalman01\pil — PIL interface code for kalman01.

Verify that the output of this run matches the output from the original kalman01.m function.

Note On a Windows operating system, the Windows Firewall can potentially block a SIL or PIL
execution. To allow the execution, use the Windows Security Alert dialog box. For example, in
Windows 7, click Allow access.

7 Terminate PIL execution

Terminate the PIL execution process.

clear kalman01_pil;

See Also

Related Examples
• “Generate C Code by Using the MATLAB Coder App”
• “Processor-in-the-Loop Execution with the MATLAB Coder App” on page 82-20
• “Generate Execution Time Profile” on page 75-3

More About
• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution” on page

82-2
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Verification of Code Generation Assumptions
The settings on the More Settings > Hardware tab specify target behavior, which result in the
implementation of implicit assumptions in the generated code. Incorrect settings can lead to:

• Suboptimal code
• Code execution failure, incorrect code output, and nondeterministic code behavior

At the start of a processor-in-the-loop (PIL) execution, the software verifies the Hardware tab
settings with reference to the target hardware. The software checks:

• The correctness of settings. For example, the integer bit length in the Sizes > int field.
• Whether the settings are optimized. For example, the rounding of signed integer division in the

Signed integer division rounds to field.

If required, the software generates warnings and errors.

See Also

Related Examples
• “Processor-in-the-Loop Execution with the MATLAB Coder App” on page 82-20
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SIL/PIL Execution Support and Limitations
Feature Supported
Output types Static library Yes

Dynamic library Yes
Executable No

Languages C Yes
C++ Yes

Interface types Inputs Yes
Outputs Yes
Constant inputs Yes
Global data Yes. SIL and PIL execution supports four

types of storage classes on page 90-2 for
MATLAB Coder global variables. The
synchronization of global data between
MATLAB and the SIL or PIL application
depends on the type of storage class that you
specify:

• ExportedGlobal (default) — The
synchronization of global data between
MATLAB and a SIL or PIL application is
identical to the synchronization between
MATLAB and a MEX function.

• ExportedDefine — There is no
synchronization of global data between
MATLAB and the SIL or PIL application.
The application uses the values of the
global variables in MATLAB at the time of
code generation.

• ImportedExtern and
ImportedExternPointer — There is no
synchronization of global data between
MATLAB and the SIL or PIL application.
The application uses initial values of
global variables, which you specify in the
external code. If the global variables are
not initialized in the external code, the SIL
or PIL execution results are undefined.

Constant global data Yes
Reentrant code Yes
Multiple entry points Yes

Data types Basic types Yes
Enumerated types Yes
Structures Yes
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Feature Supported
Complex data Yes
Fixed-point data Yes
Multiword fixed-point
data

SIL only

char arrays Yes
Empty values Yes
Cell arrays Yes

Size Scalars Yes
Fixed-size arrays Yes
Static variable-size
arrays

Yes

Dynamic variable-size
size arrays

Yes

See Also

Related Examples
• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution” on page

82-2
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Speed Up SIL/PIL Execution by Disabling Constant Input
Checking and Global Data Synchronization

By default, a SIL or PIL execution performs constant input checking and global data synchronization.
Constant input checking compares the value that a test file provides for a constant input argument
with the value specified at code generation time. If the values do not match, an error occurs. Global
data synchronization makes the values of global variables in the SIL or PIL execution environment
consistent with the values in the MATLAB workspace. If a global variable is constant and its value in
the SIL or PIL execution environment differs from its value in the MATLAB workspace, an error
occurs.

It is possible to speed up a SIL or PIL execution by disabling constant input checking or global data
synchronization. However, if you disable these features, the SIL or PIL execution results might differ
from the results in MATLAB.

Disable Constant Input Checking or Global Data Synchronization at
the Command Line
In a coder.EmbeddedCodeConfig object that you configured for SIL or PIL execution:

• To disable constant input checking, set the SILPILCheckConstantInputs property to false.
For example, for an object cfg, use this code:

cfg.SILPILCheckConstantInputs = false;

• To disable global data synchronization, set the SILPILSyncGlobalData property to false. For
example, for an object cfg, use this code:

cfg.SILPILSyncGlobalData = false;

Disable Constant Input Checking or Global Data Synchronization in the
MATLAB Coder App
In the settings for a project that you set up for SIL or PIL execution, on the Debugging tab:

• To disable constant input checking, set Check constant inputs in SIL/PIL to No.
• To disable global data synchronization, set Synchronize global data in SIL/PIL to No.

See Also

More About
• “Software-in-the-Loop Execution with the MATLAB Coder App” on page 82-4
• “Software-in-the-Loop Execution From Command Line” on page 82-6
• “Constant Input Checking in MEX Functions”
• “Generate Code for Global Data”
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SIL and PIL Verification for Deployment on Raspberry Pi
This example shows how to verify the generated code by using the software-in-the-loop (SIL) and
processor-in-the-loop (PIL) executions. In this example, the PIL execution uses a Raspberry Pi®
hardware board.

Run MATLAB Code

This example uses these supporting files:

• kalman01.m contains the MATLAB® function kalman01 for the Kalman estimator.
• position.mat contains the input data about the trajectory of an object.
• test01_ui.m is a MATLAB script that loads the input data from position.mat into the

workspace, calls kalman01 to estimate the object location by using the Kalman filtering
algorithm, and finally calls the plot_trajectory function that plots both the actual trajectory of
the object and the Kalman estimate.

• plot_trajectory.m contains the plot_trajectory function described above.

To test the MATLAB code, run the script test01_ui.

test01_ui

Current plot held

Current plot released
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In the plot that is displayed, you see that the Kalman estimate closely follows the actual trajectory of
the object. The test data includes two sudden shifts or discontinuities in position. These
discontinuities check that the Kalman filter can quickly readjust its estimate and get back to tracking
the object accurately.

For more information, see “C Code Generation for a MATLAB Kalman Filtering Algorithm”.

Software-in-the-Loop (SIL) Execution

In SIL execution, through a MATLAB SIL interface, the code generator compiles and runs library code
on your development computer.

Configure SIL Execution

Create a coder.EmbeddedCodeConfig object to generate a static C library. Set the
VerificationMode property to 'SIL'. Optionally, enable the Microsoft® Visual Studio® debugger
for SIL execution.

config = coder.config('lib');
config.VerificationMode = 'SIL';
% config.SILDebugging = true;

Check that the production hardware setting is set to the default value 'Generic->MATLAB Host
Computer'.

disp(config.HardwareImplementation.ProdHWDeviceType); 

Generic->MATLAB Host Computer

Generate Static Library and Run SIL Execution

Use the codegen command with the configuration object config to generate a static C library and
the SIL interface for the kalman01 function. To perform SIL execution, you can simply call the
generated SIL interface kalman01_sil at the MATLAB command line.

In the codegen command, the -test option enables you to run the test script test01_ui with calls
to the kalman01 function replaced by calls to the generated SIL interface kalman01_sil.

codegen -config config -args {zeros(2,1)} kalman01 -report -test test01_ui 

Code generation successful: View report
Running test file: 'test01_ui' with MEX function 'kalman01_sil.mexw64'.

Current plot held

### Starting SIL execution for 'kalman01'
    To terminate execution: clear kalman01_sil
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Current plot released

The code generator creates these output folders:

• codegen\lib\kalman01 — Static library for kalman01.
• codegen\lib\kalman01\sil — SIL interface code for kalman01.

Observe that the output of this run matches the output from the kalman01 MATLAB function.

Debug Code During SIL Execution

If you enable the Microsoft Visual Studio debugger, then running the test file opens the Microsoft
Visual Studio IDE with debugger breakpoints at the start of the kalman01_initialize and
kalman01 functions.

You can use the debugger features to observe code behavior. For example, you can step through code
and examine variables.

To end the debugging session:

• Remove all breakpoints.
• Click the Continue button (F5).

The SIL execution runs to completion.
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Terminate SIL Execution

Terminate the SIL execution process.

clear kalman01_sil;

### Stopping SIL execution for 'kalman01'

You can also use the command clear mex, which clears MEX functions from memory.

Usage Notes for Windows® platform

Usage notes for SIL execution on a Windows platform:

• The Windows Firewall can potentially block a SIL execution. To allow the execution, use the
Windows Security Alert dialog box. For example, in Windows 7, click Allow access.

• Suppose that the MATLAB current working directory (the folder that pwd displays) is a UNC path
(for example, \\server\a\b\c) on a Windows platform. If you launch a SIL executable from this
path, the location where the SIL executable is launched can be unpredictable and different from
the MATLAB current working directory (for example, C:\Windows). To fix this issue, use a
mapped network drive for the UNC path as your MATLAB current working directory.

Processor-in-the-Loop (PIL) Execution

In PIL execution, through a MATLAB PIL interface, the code generator cross-compiles and runs
production object code on a target processor or an equivalent instruction set simulator. Before you
run a PIL execution, you must set up a PIL connectivity configuration for your target. In this example,
the PIL execution uses a Raspberry Pi® hardware board.

Configure PIL Execution

Create a coder.EmbeddedCodeConfig object to generate a static C library. Set the
VerificationMode property to 'PIL'. Set the Hardware property to a hardware board
configuration object for Raspberry Pi.

config = coder.config('lib');
config.VerificationMode = 'PIL';
config.Hardware = coder.hardware('Raspberry Pi');

If you are to your Raspherry Pi hardware board for the first time, you must also specify the
Username, DeviceAddress, and Password properties of the config.Hardware parameter.

Generate Static Library and Run PIL Execution

Use the codegen command with the configuration object config to generate a static C library and
the PIL interface for the kalman01 function. To perform PIL execution, you can simply call the
generated PIL interface kalman01_pil at the MATLAB command line.

In the codegen command, the -test option enables you to run the test script test01_ui with calls
to the kalman01 function replaced by calls to the generated PIL interface kalman01_pil.

codegen -config config -args {zeros(2,1)} kalman01 -report -test test01_ui 

### Connectivity configuration for function 'kalman01': 'Raspberry Pi'
Location of the generated elf : /home/pi/MATLAB_ws/R2021a/C/Users/aghosh/Documents/Examples/ecoder-ex65983262/codegen/lib/kalman01/pil
Code generation successful: View report
Running test file: 'test01_ui' with MEX function 'kalman01_pil.mexw64'.
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Current plot held

### Connectivity configuration for function 'kalman01': 'Raspberry Pi'
### Starting application: 'codegen\lib\kalman01\pil\kalman01.elf'
    To terminate execution: clear kalman01_pil
### Launching application kalman01.elf...

Current plot released

The code generator creates these output folders:

• codegen\lib\kalman01 — Static library for kalman01.
• codegen\lib\kalman01\pil — PIL interface code for kalman01.

Observe that the output of this run matches the output from the kalman01 MATLAB function.

The Windows Firewall can potentially block a PIL execution. To allow the execution, use the Windows
Security Alert dialog box. For example, in Windows 7, click Allow access.

Terminate PIL Execution

Terminate the PIL execution process.

clear kalman01_pil;

### Host application produced the following standard output (stdout) and standard error (stderr) messages:
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You can also use the command clear mex, which clears MEX functions from memory.

See Also
codegen | coder.EmbeddedCodeConfig | coder.config

More About
• “Code Verification Through Software-in-the-Loop and Processor-in-the-Loop Execution” on page

82-2
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Software-in-the-loop Execution For MATLAB Function with
Multiple Signatures

In this section...
“Generate Multisignature SIL MEX File for an Entry-Point Function” on page 82-36
“Generate Multisignature SIL MEX File for Multiple Entry-Point Functions” on page 82-37

For MATLAB function with multiple signatures, software-in-the-loop (SIL) enables you to verify the
generated C/C++ code by using a SIL MEX file that supports multiple signatures. This feature
enables you to generate one SIL MEX file for verification instead of generating separate SIL MEX
files for each signature.

Generate Multisignature SIL MEX File for an Entry-Point Function
1 MATLAB code for myAdd function

Copy the MATLAB code of one entry-point function myAdd, and save it in your working directory.

The entry-point function, myAdd, returns the sum of two values.

function y = myAdd(a,b)
%#codegen
y = a+b;
end

2 Configure SIL execution

Create a coder.EmbeddedCodeConfig object and configure the object for SIL.

cfg = coder.config('lib');
cfg.VerificationMode = "SIL";

3 Generate code using codegen command

The codegen command generates a SIL MEX file myAdd_sil that works with three different
data types: double, int8, and vector of doubles. You specify the entry-point function
followed by -args for each signature of the entry-point function.

codegen -config cfg myAdd -args {1,2} -args {int8(2),int8(3)} -args {1:10,1:10} -report
4 Run generated SIL MEX file myAdd_sil

At the command prompt, call the generated SIL MEX file myAdd_sil. Make sure that the values
you pass to myAdd_sil match the input properties that you specified in the codegen command.

myAdd_sil(3,4)

ans =

     7

myAdd_sil(int8(5),int8(6))

ans =

  int8
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   11

myAdd_sil(1:10,2:11)

ans =

     3     5     7     9    11    13    15    17    19    21

Running the MATLAB function myAdd with these input values produces the same output. These
test cases verify that myAdd and myAdd_sil have the same behavior.

5 Terminate SIL execution

Terminate the SIL execution process.

clear myAdd_sil;

You can also use the command clear mex, which clears MEX files from memory.
6 Entry Point Summary Report

In the generated code, different signatures are mapped to versioned entry-point functions
myAdd1, myAdd2, and myAdd3 as shown in the figure.

Generate Multisignature SIL MEX File for Multiple Entry-Point
Functions
1 MATLAB code for myAdd and myMul functions

Copy the MATLAB codes of two entry-point functions, myAdd and myMul and save it in your
working directory.

The first entry-point function, myAdd, returns the sum of two values:

function y = myAdd(a,b)
%#codegen
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y = a+b;
end

The second entry-point function, myMul, returns the multiplication of two values:

function y = myMul(a,b)
%#codegen
y = a*b;
end

2 Configure SIL execution

Create a coder.EmbeddedCodeConfig object and configure the object for SIL.

cfg = coder.config('lib');
cfg.VerificationMode = "SIL";

3 Generate code using codegen command

The codegen command generates a SIL MEX file myMath_sil for all the signatures that you
specified in the codegen command. The SIL MEX file myMath_sil works for myAdd and myMul
with two different data types: double, and int8. You specify the entry-point function followed by
-args for each signature of the entry-point function.

codegen -config cfg myAdd.m -args {1,2} -args {int8(1),int8(2)} myMul.m -args {1,2} -args {int8(1),int8(2)} -o 'myMath' -report
4 Run generated SIL MEX file myMath_sil

At the command prompt, call the generated SIL MEX file myMath_sil. Make sure that the
values you pass to myMath_sil match the input properties that you specified in the codegen
command.

myMath_sil("myAdd",3,4)

ans =

     7

myMath_sil("myAdd",int8(5),int8(6))

ans =

   int8 

   11

myMath_sil("myMul",3,4)

ans =

     12

myMath_sil("myMul",int8(5),int8(6))

ans =

    int8

    30
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Running the MATLAB function myAdd and myMul with these input values produces the same
output. These test cases verify that myAdd, myMul and the generated SIL MEX file myMath_sil
have the same behavior.

5 Terminate SIL execution

Terminate the SIL execution process.

clear myMath_sil;

You can also use the command clear mex, which clears MEX files from memory.
6 Entry Point Summary Report

In the generated code, different signatures are mapped to versioned entry-point functions
myAdd1, myAdd2, myMul1 and myMul2 as shown in the figure.

Example main file provides information about how to use entry-points in your application.
“Incorporate Generated Code Using an Example Main Function”, helps to generate example main.c
file.

Note You can implement the multisignature PIL MEX for an entry-point function and multiple entry-
point functions in the same way that the multisignature SIL MEX is implemented.
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Limitations
The multisignature SIL MEX and PIL MEX generation does not have graphical user interface (GUI)
support.

See Also
codegen | coder.config

More About
• “Generate Code for Multiple Entry-Point Functions”
• “Generate One MEX Function for Multiple Signatures”
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Code Coverage in Embedded Coder

• “Simulink Code Coverage Metrics” on page 83-2
• “Code Coverage for Models in Software-in-the-Loop (SIL) Mode and Processor-in-the-Loop (PIL)

Mode” on page 83-5
• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “View Code Coverage Information at the End of SIL or PIL Simulations” on page 83-10
• “Configure Code Coverage Programmatically” on page 83-13
• “Code Coverage Summary and Annotations” on page 83-15
• “Code Coverage Tool Support” on page 83-21
• “Tips and Limitations” on page 83-22
• “Collect Code Coverage Metrics with a Third-Party Tool” on page 83-25
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Simulink Code Coverage Metrics
In this section...
“Statement Coverage for Code Coverage” on page 83-2
“Condition Coverage for Code Coverage” on page 83-2
“Decision Coverage for Code Coverage” on page 83-3
“Modified Condition/Decision Coverage (MCDC) for Code Coverage” on page 83-3
“Cyclomatic Complexity for Code Coverage” on page 83-4
“Relational Boundary for Code Coverage” on page 83-4

If you have a Simulink Coverage license, you can run a SIL or PIL simulation that produces code
coverage metrics for generated model code. The simulation performs several types of code coverage
analysis.

Statement Coverage for Code Coverage
Statement coverage determines the number of source code statements that execute when the code
runs. Use this type of coverage to determine whether every statement in the program has been
invoked at least once.

Statement coverage = (Number of executed statements / Total number of statements) *100

Statement Coverage Example

This code snippet contains five statements. To achieve 100% statement coverage, you need at least
three test cases. Specifically, tests with positive x values, negative x values, and x values of zero.

if (x > 0)
  printf( "x is positive" );
else if (x < 0)
  printf( "x is negative" );
else
  printf( "x is 0" );

Condition Coverage for Code Coverage
Condition coverage analyzes statements that include conditions in source code. Conditions are C/C+
+ Boolean expressions that contain relation operators (<, >, <=, or >=), equation operators (!= or ==),
or logical negation operators (!), but that do not contain logical operators (&& or ||). This type of
coverage determines whether every condition has been evaluated to all possible outcomes at least
once.

Condition coverage = (Number of executed condition outcomes / Total number of condition outcomes)
*100

Condition Coverage Example

In this expression:

y = x<=5 && x!=7;
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there are these conditions:

x<=5
x!=7

Decision Coverage for Code Coverage
Decision coverage analyzes statements that represent decisions in source code. Decisions are
Boolean expressions composed of conditions and one or more of the logical C/C++ operators && or
||. Conditions within branching constructs (if/else, while, do-while) are decisions. Decision coverage
determines the percentage of the total number of decision outcomes the code exercises during
execution. Use this type of coverage to determine whether all decisions, including branches, in your
code are tested.

Note The decision coverage definition for DO-178C compliance differs from the Simulink Coverage
definition. For decision coverage compliance with DO-178C, select the Condition Decision
structural coverage level for Boolean expressions not containing && or || operators.

Decision coverage = (Number of executed decision outcomes / Total number of decision outcomes)
*100

Decision Coverage Example

This code snippet contains three decisions:

y = x<=5 && x!=7;                // decision #1

if( x > 0 )                    // decision #2
  printf( "decision #2 is true" );
else if( x < 0 && y )                // decision #3
  printf( "decision #3 is true" ); 
else
  printf( "decisions #2 and #3 are false" );

Modified Condition/Decision Coverage (MCDC) for Code Coverage
Modified condition/decision coverage (MCDC) is the extent to which the conditions within decisions
are independently exercised during code execution.

• All conditions within decisions have been evaluated to all possible outcomes at least once.
• Every condition within a decision independently affects the outcome of the decision.

MCDC coverage = (Number of conditions evaluated to all possible outcomes affecting the outcome of
the decision / Total number of conditions within the decisions) *100

Modified Condition/Decision Coverage Example

For this decision:

X || ( Y && Z )

the following set of test cases delivers 100% MCDC coverage.
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 X Y Z
Test case #1 0 0 1
Test case #2 0 1 0
Test case #3 0 1 1
Test case #4 1 0 1

Cyclomatic Complexity for Code Coverage
Cyclomatic complexity is a measure of the structural complexity of code that uses the McCabe
complexity measure. To compute the cyclomatic complexity of code, code coverage uses this formula:

c = ∑
1

N
(on− 1)

N is the number of decisions in the code. on is the number of outcomes for the nth decision point.
Code coverage adds 1 to the complexity number for each C/C++ function.

Coverage Example

For this code snippet, the cyclomatic complexity is 3:

void evalNum(int x)
{
  if (x > 0)                          // decision #1
    printf( "x is positive" );
  else if (x < 0)                     // decision #2
    printf( "x is negative" );
  else
    printf( "x is 0" );
}

The code contains one function that has two decision points. Each decision point has two outcomes.
Using the preceding formula, N is 2, o1 is 2, and o2 is 2. Code coverage uses the formula with these
decisions and outcomes and adds 1 for the function. The cyclomatic complexity for this code snippet
is:

c = (o1 − 1) + (o2 − 1) + 1 = (2 − 1) + (2 − 1) + 1 = 3

Relational Boundary for Code Coverage
Relational boundary code coverage examines code that has relational operations. Relational boundary
code coverage metrics align with those for model coverage, as described in “Relational Boundary
Coverage” (Simulink Coverage). Fixed-point values in your model are integers during code coverage.

See Also

Related Examples
• “Code Coverage for Models in Software-in-the-Loop (SIL) Mode and Processor-in-the-Loop (PIL)

Mode” on page 83-5
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Code Coverage for Models in Software-in-the-Loop (SIL) Mode
and Processor-in-the-Loop (PIL) Mode

If you have Embedded Coder and Simulink Coverage, you can analyze coverage for generated code
during a software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation.

In this section...
“Enable SIL or PIL Code Coverage for a Model” on page 83-5
“Review the Coverage Results for Models in SIL or PIL Mode” on page 83-5
“Limitations” on page 83-7

Enable SIL or PIL Code Coverage for a Model
To record SIL or PIL code coverage for a model:

1 In the Configuration Parameters dialog box, on the left pane, click Code Generation. From the
list, select Verification.

2 Under Code profiling, set Measure function execution times to Off.
3 Under Code coverage for SIL or PIL, set Third-party tool to None (use Simulink

Coverage).
4 Enable coverage for a model in SIL or PIL mode or a reference model in SIL or PIL mode.
5 Run a SIL or PIL simulation.

Note The Coverage (Run) button in the Coverage toolstrip forces a Normal simulation and will
not yield SIL or PIL code coverage.

Review the Coverage Results for Models in SIL or PIL Mode
Code Coverage Report

In the code coverage report, each hyperlink opens a report with more details on the coverage
analysis for the model. The code coverage results in these reports are similar to the coverage results
for C/C++ code in S-function blocks, as described in “View Coverage Results for Custom C/C++ Code
in S-Function Blocks” (Simulink Coverage). You can navigate from code coverage results to the
associated model blocks by using the links within the detailed code coverage reports.
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Each detailed code coverage report also contains syntax highlighted code with coverage information.

Code View

To view the code coverage information in the Code view, from the drop-down list to the right of the
search box, select Show code coverage. If the option is disabled, then on the Coverage tab, click
Coverage Highlighting. The code displays highlighting and annotations that show code coverage
information. You can navigate from the code to the associated model blocks by using the links in the
line numbers, code elements, and comments.
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At the bottom of the Code view, the coverage section shows a summary of the code coverage report.

Limitations
Coverage for models in SIL and PIL mode has these limitations:

• The model must meet the requirements listed in “Enable SIL or PIL Code Coverage for a Model”
on page 83-5.

• Code coverage results must not include external C/C++ files in read-only folders.
• The Coverage (Run) button in the Coverage toolstrip forces a Normal simulation and will not

yield SIL or PIL code coverage.

See Also

Related Examples
• “Custom Toolchain Directives Required for Code Coverage and Execution Profiling” on page 80-

59
• “Software-in-the-Loop Code Coverage” (Simulink Coverage)
• “SIL/PIL Manager Verification Workflow” on page 80-67
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Configure Code Coverage with Third-Party Tools
During a top-model or Model block SIL or PIL simulation, you can collect code coverage metrics for
generated code using a third-party tool. Embedded Coder supports the following tools:

• LDRA Testbed from LDRA Software Technology. For information about installing and using this
tool, go to www.ldra.com.

The software supports LDRA Testbed code coverage for SIL and PIL.

• BullseyeCoverage from Bullseye Testing Technology. For information about installing and using
this tool, go to www.bullseye.com.

The software supports BullseyeCoverage code coverage for SIL and, in certain cases, PIL.

To configure a code coverage tool for a top-model or Model block SIL or PIL simulation, in the
Configuration Parameters dialog box, select the Verification pane:

1 From the Third-party tool drop-down list, select a tool, for example, BullseyeCoverage or
LDRA Testbed.

2 Click Configure to open the Code Coverage Settings dialog box.
3 In the Installation folder field, specify the location where your coverage tool is installed. If you

click Browse, the Select Installation Folder dialog box opens, which allows you to navigate to the
folder where your coverage tool is installed. The software detects and displays the tool version.

By default, the following parameters are enabled:

• Code coverage for this model — Generate coverage data for the current (top) model.
• Code coverage for referenced models — Generate data for models referenced by the

current (top) model.

If your top model has Model blocks, these parameters of the top model override the
corresponding parameters of referenced models.

4 Click OK. You return to Verification settings.
5 To view cumulative code coverage results within a code generation report, in the Report pane of

the Configuration Parameters dialog box, select these check boxes:

• Create code generation report
• Open report automatically

6 Click OK.
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With LDRA Testbed:

• The evaluation of cumulative code coverage begins from the point when you last added a new file
to the existing set of source files. For example, existing code coverage results are deleted when
you:

• Run a simulation with a new model using the existing code generation folder.
• Run a simulation that results in additional source code files being instrumented.

• If you switch between SIL and PIL simulations of a model, the software generates separate
cumulative code coverage results for the SIL and PIL simulations.

For a model in a reference hierarchy, the software does not support simultaneous function execution
time measurement and code coverage.

See Also

Related Examples
• “Configure and Run SIL Simulation” on page 80-15
• “SIL/PIL Manager Verification Workflow” on page 80-67
• “Configure Code Coverage Programmatically” on page 83-13
• “View Code Coverage Information at the End of SIL or PIL Simulations” on page 83-10
• “Collect Code Coverage Metrics with a Third-Party Tool” on page 83-25
• “Code Coverage Tool Support” on page 83-21
• “Minor SIL and PIL Differences for LDRA Testbed” on page 83-23
• “PIL Support for BullseyeCoverage” on page 83-24
• “Simulink Code Coverage Metrics” on page 83-2
• “Code Coverage for Models in Software-in-the-Loop (SIL) Mode and Processor-in-the-Loop (PIL)

Mode” on page 83-5

External Websites
• www.ldra.com
• www.bullseye.com
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View Code Coverage Information at the End of SIL or PIL
Simulations

In this section...
“View LDRA Testbed Results” on page 83-10
“View BullseyeCoverage Results” on page 83-11

If you configure third-party code coverage for a SIL or PIL simulation, when the simulation is
complete, the code generation report opens automatically and you see hyperlinks in the Command
Window.

View LDRA Testbed Results
If you specified the LDRA Testbed, you see three links in the Command Window:
### Starting SIL simulation for component: rtwdemo_sil_topmodel
### Stopping SIL simulation for component: rtwdemo_sil_topmodel
### Starting analysis of coverage data
### Use the following links to view code coverage results:
    LDRA Testbed GUI
    LDRA Testbed Code Coverage Overview Report
    HTML code generation report with code coverage annotations
### Completed code coverage analysis
>> 

To go to the LDRA Testbed GUI, click the LDRA Testbed GUI link.

To open the LDRA Testbed Report with your Web browser, click the LDRA Testbed Code Coverage
Overview Report link.
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For information about using this report, refer to the LDRA Testbed documentation.

LDRA Testbed analysis results for all code in the current code generation folder belong to a set. In
this set, you can find analysis results for models that share the same code generation folder. The
LDRA Testbed Code Coverage Overview Report link identifies the location of the LDRA
Testbed analysis results, which is determined by:

• The LDRA Testbed configuration.
• The name of the LDRA Testbed set associated with the current code generation folder.

To view summary data and code annotations with coverage information in the code generation report,
click the HTML code generation report with code coverage annotations link. To view
the code coverage information in the Code view, from the drop-down list to the right of the search
box, select Show code coverage.

View BullseyeCoverage Results
If you specified the BullseyeCoverage tool, you see two links in the Command Window:
### Starting SIL simulation for component: rtwdemo_sil_topmodel
### Stopping SIL simulation for component: rtwdemo_sil_topmodel
### Processing code coverage data
### Use the following links to view code coverage results:
    BullseyeCoverage browser (coverage for last run)
    HTML code generation report (cumulative coverage)
### Completed code coverage analysis
>> 
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To view the coverage report using the BullseyeCoverage Browser, click the BullseyeCoverage
browser (coverage for last run) link.

The BullseyeCoverage Browser shows coverage data for instrumented files associated with your
latest top-model simulation. The coverage data shown in the browser is not cumulative and pertains
only to the most recent simulation. For information about the BullseyeCoverage Browser, go to
www.bullseye.com.

To view summary data and code annotations with coverage information in the code generation report,
click the HTML code generation report (cumulative coverage) link. To view the code
coverage information in the Code view, from the drop-down list to the right of the search box, select
Show code coverage.

See Also

Related Examples
• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “Collect Code Coverage Metrics with a Third-Party Tool” on page 83-25
• “Code Coverage Summary and Annotations” on page 83-15
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Configure Code Coverage Programmatically
For a software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation, you can configure third-
party code coverage analysis by using command-line APIs.

Set Up Third Party Code Coverage From Command Line
For BullseyeCoverage, you can use this workflow:

1 Using get_param, retrieve the object containing coverage settings for the current model. For
example:
covSettings = get_param(gcs, 'CodeCoverageSettings')

covSettings = 

  CodeCoverageSettings with properties:

           TopModelCoverage: 'off'
    ReferencedModelCoverage: 'off'
               CoverageTool: 'None'

The property TopModelCoverage determines whether the software generates code coverage
data for just the top model, while ReferencedModelCoverage determines whether the
software generates coverage data for models referenced by the top model. If neither property is
'on', the code generator does not produce code coverage data during a SIL or PIL simulation.

When you save your model, the properties TopModelCoverage, ReferencedModelCoverage,
and CoverageTool are also saved.

2 Check the class of covSettings.
class(covSettings)

ans = 

    'coder.coverage.CodeCoverageSettings'

3 Turn on BullseyeCoverage code coverage analysis for the top model and referenced models.
covSettings.TopModelCoverage='on';
covSettings.ReferencedModelCoverage='on';
covSettings.CoverageTool='BullseyeCoverage';

To specify LDRA Testbed as the code coverage tool, set the property CoverageTool to 'LDRA
Testbed'.

4 Using set_param, apply the new coverage settings to the model.
set_param(gcs,'CodeCoverageSettings', covSettings);

5 Assuming the third-party code coverage tool is installed, specify the installation path.
coder.coverage.BullseyeCoverage.setPath('C:\Program Files\BullseyeCoverage')

For LDRA Testbed, use coder.coverage.LDRA.setPath('C:\...).
6 Check that the path is saved as a preference.

coder.coverage.BullseyeCoverage.getPath

For LDRA Testbed, use coder.coverage.LDRA.getPath.
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Code Coverage for Model That Uses Configuration Reference
If your model uses a configuration set that is not attached to the model, for example, a configuration
reference, then the Configure button is dimmed in the Configuration Parameters dialog box. You
cannot open the Code Coverage Settings dialog box and you must use line commands to specify code
coverage settings.

To configure third-party code coverage analysis for a model that uses a configuration reference:

1 Get the active configuration set from the model.
cs = getActiveConfigSet(gcs)

2 Retrieve the current code coverage settings.
covSettings = get_param(cs, 'CodeCoverageSettings')

3 Specify the code coverage settings that you require. For example:
covSettings.TopModelCoverage = 'on';
covSettings.ReferencedModelCoverage='on';
covSettings.CoverageTool='BullseyeCoverage';

4 Get the configuration set that is specified by the configuration reference.
csBase = cs.getRefConfigSet

5 Apply the required code coverage settings to the referenced configuration set.
set_param(csBase, 'CodeCoverageSettings', covSettings);

The active configuration set for the model contains the code coverage settings that you require.

See Also

Related Examples
• “Collect Code Coverage Metrics with a Third-Party Tool” on page 83-25
• “Configure Code Coverage with Third-Party Tools” on page 83-8
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Code Coverage Summary and Annotations
In this section...
“LDRA Testbed Coverage” on page 83-15
“BullseyeCoverage Information” on page 83-18

If you specify a code coverage tool for a SIL or PIL simulation, the software produces a code
generation report that provides summary data and code annotations with coverage information. Each
code annotation is associated with a code feature and indicates the nature of the feature coverage
during code execution.

The code generation report also allows you to navigate easily between blocks in your model and the
corresponding sections in the source code. You can also view coverage annotations and navigate to
the corresponding model blocks in the Code view.

LDRA Testbed Coverage
The cumulative coverage data in a code generation report is derived from instrumented files
associated with your latest top-model simulation and coverage data collected from simulations with
other top models that share referenced models with your current top model.

The software provides LDRA Testbed annotations in the code generation report and in the Code view
to help you to review code coverage.

Note Do not use the code generation report alone to verify that you have achieved your coverage
goals. You must refer to the LDRA Testbed Report.

This example shows three kinds of annotations. On lines 134, 139, 140, and 141, the annotation 
indicates that statement coverage for each of these lines of code is not complete.

Placing the cursor over the annotation =>b produces a tooltip.
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This tooltip indicates that only one branch destination is covered. The code within the curly brackets,
which starts at column 45 of line 134, is not executed. As the if statement on line 139 lies within this
code, the corresponding annotation => states that the branch is not covered.

In the Code view, the color of each bar and annotations shows the amount of coverage of the
corresponding line of code or code feature. Green indicates full coverage, yellow indicates partial
coverage, and red indicates no coverage.

Place your cursor over the annotation ^b to see a tooltip. the tooltip indicates which branch
destinations are covered and which are not covered.
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This table describes the LDRA Testbed code annotations that you might see in a code generation
report produced by a SIL and PIL simulations.

Code feature Annotation symbol What happened during
simulation

Function Fcn Function name returned through
this exit point.

=> Function name never returned
through this exit point.

Branch/condition => Condition not encountered.
=>t Condition evaluated true only.
=>f Condition evaluated false only.
tf Condition evaluated both true

and false.
Branch/decision => Branch never encountered.

=>b Branch to at least one
destination covered and branch
to at least one other destination
not covered.

b Branch fully exercised.
Modified Condition/Decision
Coverage (MC/DC)

=>mc Condition did not independently
affect outcome of decision.

mc Condition independently
affected outcome of decision.

Statement Statements associated with line
covered.
Not all statements associated
with line covered.
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Code feature Annotation symbol What happened during
simulation

Code that is reformatted by
LDRA Testbed and does not
match the original source code.
For example, source code with
#include statements to include
other files, and source code with
#define statements for
macros.

For detailed coverage
information, refer to the LDRA
Testbed report.

=>Σ Zero coverage — probes within
source code line or files
included by source code line not
exercised.

=>Σ Coverage probes within source
code line or any included file
partially exercised.

Σ Coverage probes within source
code line or included files fully
exercised.

BullseyeCoverage Information
The cumulative coverage data in a code generation report is derived from instrumented files
associated with your latest top-model simulation and coverage data collected from simulations with
other top models that share referenced models with your current top model.

The software provides BullseyeCoverage annotations in the code generation report and in the Code
view to help you to review code coverage.

This example shows two kinds of annotations. At line 41, TF indicates that the if decision had both
true and false outcomes during the simulation. At line 52, =>F indicates that the if decision was
false only during the simulation.

In the Code view, the color of each bar and annotations shows the amount of coverage of the
corresponding line of code or code feature. Green indicates full coverage, yellow indicates partial
coverage, and red indicates no coverage.
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This table describes the BullseyeCoverage code annotations that you might see in a code generation
report produced by a SIL simulation.

Code feature Annotation symbol What happened during
simulation

Decision => Decision not executed.
TF Decision evaluated both true

and false.
=>T Decision evaluated true only.
=>F Decision evaluated false only.

Function => Function not called.
Fcn Function called.

Switch label => Switch command not used.
Sw Switch command used.

Constant k Decision or condition was
constant, which did not allow
any variation in coverage.

Condition => Condition not encountered.
tf Condition evaluated both true

and false.
=>t Condition evaluated true only.
=>f Condition evaluated false only.

Try => Try block never completed.
Try Try block covered.

Catch => Catch block not covered.
Cat Catch block covered.

See Also

Related Examples
• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “View Code Coverage Information at the End of SIL or PIL Simulations” on page 83-10
• “Trace Simulink Model Elements in Generated Code” on page 77-8
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• “Collect Code Coverage Metrics with a Third-Party Tool” on page 83-25
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Code Coverage Tool Support
Embedded Coder code coverage provides the following support for the BullseyeCoverage and LDRA
Testbed tools.

Operating system BullseyeCoverage LDRA Testbed
Version supported Compiler

supported
Version supported Compiler

supported
Windows 8.15.41 Microsoft Visual C+

+ (MSVC)
9.4.6 • Microsoft Visual

C++ (MSVC)
• LCC
• MinGW

Linux 8.15.41 gcc 9.4.6 gcc
Mac Not supported Not supported

See Also

Related Examples
• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “Select and Configure C or C++ Compiler”
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Tips and Limitations

Model Build and SIL/PIL Blocks Not Supported
Code coverage does not support:

• The model build process, for example, the Ctrl+B command.
• SIL or PIL blocks.

Code coverage settings are ignored by the Ctrl+B command and SIL or PIL blocks.

BullseyeCoverage License Wait
When you build your model, you might have to wait for a BullseyeCoverage license. If you want to see
information about the wait, before you build your model, in the Configuration Parameters dialog box,
select Verbose build.

Current Working Folder Cannot be UNC Path
If your MATLAB current working folder is a Universal Naming Convention (UNC) path, code coverage
fails.

Characters in matlabroot and File Path
If matlabroot or the path to your generated files contains a space or the . (period) character, code
coverage might fail.

Header Files with Identical Names
Consider a model that is configured for LDRA Testbed code coverage. During the build process, if the
software detects two header files with the same name in the folder for generated code, the software
generates an error.

Code Coverage for Source Files in Shared Utility Folders
The software supports code coverage for source files generated in shared utility folders. If you
configure code coverage for a model that uses shared utility code generation, when you build the
model, you also build all source files in the shared utilities folder with code coverage enabled.

Whenever you build a model, the code coverage settings of the model must be consistent with source
files that you previously built in the shared utilities folder. Otherwise, the software reports that code
in the shared utilities folder is inconsistent with the current model configuration and must be rebuilt.
For example, if you run a SIL simulation for a model with code coverage enabled and then run a SIL
simulation for another model with code coverage disabled, the software must rebuild all source files
in the shared utilities folder.

BullseyeCoverage Behavior with Inline Macros
The BullseyeCoverage tool, by default, does not provide code coverage data for inline macros.
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For example, if a model generates a file slprj/ert/_sharedutils/rt_SATURATE.h that contains
the macro

#define rt_SATURATE(sig,ll,ul) (((sig) >= (ul)) ? (ul) : (((sig) <= (ll)) ?
(ll) : (sig)) )

and the macro is in sat_ert_rtw/sat.c, then the coverage report provides a measurement for
sat.c, but no coverage data for the conditions within the macro rt_SATURATE.

To configure the BullseyeCoverage tool to provide code coverage data for inline macros:

1 Open the BullseyeCoverage Browser.
2 Select Tools > Options to open the Options dialog box.
3 On the Build tab, select the Instrument macro expansions check box.
4 Click OK.
5 Rerun your simulation.

Alternatively, you can add the text -macro to the BullseyeCoverage configuration file. For more
information, go to www.bullseye.com/help.

SIL and PIL Simulations with Open LDRA Testbed
If you enable code coverage with the LDRA Testbed tool, you must verify that the LDRA Testbed GUI
is not open when you run your SIL or PIL simulation. If the set name in the LDRA Testbed GUI differs
from the set name used by the SIL or PIL simulation, the SIL or PIL simulation fails.

Minor SIL and PIL Differences for LDRA Testbed
The target connectivity API supports code coverage with LDRA Testbed for top-model and Model
block PIL.

There are minor differences in the code coverage information collected during SIL and PIL
simulations. In particular, with PIL, the software does not explicitly show function exit point coverage.
However, you can infer the coverage of function exit points by examining statement coverage.
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PIL Zero Coverage LDRA Testbed Annotations
For a PIL simulation with LDRA Testbed code coverage specified, there might be some source files
where the recorded coverage is zero. In this case, the software provides summary information
indicating that:

• There is coverage to measure.
• The coverage is zero.

You do not see information for individual probes on each line. The displayed summary information has
an associated annotation tooltip:
0 out of N coverage probes were exercised (detailed breakdown unavailable)

PIL Support for BullseyeCoverage
Code coverage with BullseyeCoverage is available for top-model and Model block PIL provided your
PIL application can write directly to the host file system. Your target for the PIL application must
provide fopen and fread access to the host file system.

If code coverage is not available when you run the PIL application on your target hardware, you
might be able to collect code coverage measurements by running the PIL application on an
instruction set simulator that supports direct file I/O with the host file system.

Modify Legacy Code
If you modify legacy code and rerun a SIL or PIL simulation, the legacy code is recompiled. However,
the code from the model may be up-to-date. In this case, the code generation report is not updated
and does not show the modified legacy code. Instead, the code coverage information for the modified
legacy code is displayed with reference to the original legacy code. You must regenerate the report.
For more information, see “Limitation”.

See Also

Related Examples
• “Configure Code Coverage with Third-Party Tools” on page 83-8
• “Configure Code Coverage Programmatically” on page 83-13
• “View Code Coverage Information at the End of SIL or PIL Simulations” on page 83-10
• “Code Coverage Summary and Annotations” on page 83-15
• “Code Coverage Tool Support” on page 83-21
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Collect Code Coverage Metrics with a Third-Party Tool
If Simulink® Coverage™ is installed, you can collect code coverage metrics during a software-in-the-
loop (SIL) or processor-in-the-loop (PIL) simulation - see “Collect Code Coverage Data” (Simulink
Coverage). In this example, you can collect code coverage metrics with a third-party tool, i.e.,
BullseyeCoverage or LDRA Testbed. You must install the third-party tool - see “Code Coverage Tool
Support” on page 83-21.

This screen shot shows a code coverage report obtained by running a SIL simulation with a code
coverage tool enabled. The annotations depend on the code coverage tool that you specify.
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In this example, you measure model coverage during normal mode simulation and repeat the same
simulation in SIL mode to measure code coverage. By using the hyperlinks in the model coverage and
code coverage reports, you can compare model coverage and code coverage results.

For SIL and PIL simulation examples, see “Test Generated Code with SIL and PIL Simulations” on
page 80-85.

Initial Setup

Make sure the model is newly opened.

model='rtwdemo_sil_topmodel';
close_system(model,0)
open_system(model)
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Remove existing build folders.

buildFolder=RTW.getBuildDir(model);
if exist(buildFolder.BuildDirectory,'dir')
    rmdir(buildFolder.BuildDirectory,'s');
end

Configure generation of model coverage report.

set_param(model, 'RecordCoverage','on')
clear covCumulativeData

Set up the stimulus data.

 Collect Code Coverage Metrics with a Third-Party Tool

83-27



T=0.1; % sample time
[ticks_to_count, reset, counter_mode, count_enable, ...
 counter_mode_values_run1, counter_mode_values_run2, ...
 count_enable_values_run1, count_enable_values_run2] = ...
    rtwdemo_sil_topmodel_data(T);

Run a Simulation in Normal Mode

The model is configured to collect model coverage metrics. When a simulation is complete, the model
coverage report opens. Use the coverage display window to navigate from blocks in the model to the
corresponding sections of the coverage report.

counter_mode.signals.values = counter_mode_values_run1;
count_enable.signals.values = count_enable_values_run1;
set_param(model,'SimulationMode','normal');

Set up Simulation Data Inspector for interactive viewing and comparison of simulation results.

Simulink.sdi.view;
Simulink.sdi.clear;

Run the simulation.

simout_normal_run1 = sim(model, 'ReturnWorkspaceOutputs', 'on');

Capture the results.

Simulink.sdi.createRun('Run 1 (normal mode)', 'namevalue',...
                       {'simout_normal_run1'}, {simout_normal_run1});

Run a Second Simulation in Normal Mode

For the first simulation, the report shows that the achieved coverage is less than 100%. Run a second
simulation with different input signals that increase the level of MC/DC coverage to 100%. Note that
the model coverage report is configured to show cumulative coverage across both simulation runs.

counter_mode.signals.values = counter_mode_values_run2;
count_enable.signals.values = count_enable_values_run2;
set_param(model,'SimulationMode','normal');

simout_normal_run2 = sim(model, 'ReturnWorkspaceOutputs', 'on');

Simulink.sdi.createRun('Run 2 (normal mode)', 'namevalue',...
                       {'simout_normal_run2'}, {simout_normal_run2});

Configure the Model to Measure Code Coverage

Before running a SIL simulation, check the availability of third-party tools, and configure the model to
collect code coverage metrics. If a third-party tool is not available, the model uses Simulink®
Verification and Validation™.

covToolPath = '';
ldraPath = coder.coverage.LDRA.getPath;
bullseyePath = coder.coverage.BullseyeCoverage.getPath;

coverageSettings = get_param(model,'CodeCoverageSettings');
coverageSettings.TopModelCoverage='on';
if ~isempty(ldraPath)
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    coverageSettings.CoverageTool='LDRA Testbed';
elseif ~isempty(bullseyePath)
    coverageSettings.CoverageTool='BullseyeCoverage';
else
    coverageSettings.CoverageTool='None';
end
set_param(model,'CodeCoverageSettings',coverageSettings);

Run Simulations in SIL Mode

The normal mode simulations produce coverage metrics for the model. With a SIL simulation, you can
apply the same input stimulus signals to the generated code and measure code coverage.

Run the first simulation in SIL mode.

counter_mode.signals.values = counter_mode_values_run1;
count_enable.signals.values = count_enable_values_run1;
set_param(model,'SimulationMode','software-in-the-loop');
set_param(model,'CodeExecutionProfiling','off');
set_param(model,'CodeProfilingInstrumentation','off');
simout_sil_run1 = sim(model, 'ReturnWorkspaceOutputs', 'on');
Simulink.sdi.createRun('Run 1 (SIL mode)', 'namevalue',...
                       {'simout_sil_run1'}, {simout_sil_run1});

### Starting build procedure for: rtwdemo_sil_topmodel
### Successful completion of build procedure for: rtwdemo_sil_topmodel

Build Summary

Top model targets built:

Model                 Action                       Rebuild Reason                                    
=====================================================================================================
rtwdemo_sil_topmodel  Code generated and compiled  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 44.156s
### Preparing to start SIL simulation ...
Building with 'MinGW64 Compiler (C)'.
MEX completed successfully.
### Updating code generation report with SIL files ...
### Starting SIL simulation for component: rtwdemo_sil_topmodel
### Stopping SIL simulation for component: rtwdemo_sil_topmodel
### Completed code coverage analysis

Run the second simulation in SIL mode.

counter_mode.signals.values = counter_mode_values_run2;
count_enable.signals.values = count_enable_values_run2;
set_param(model,'SimulationMode','software-in-the-loop');
set_param(model,'CodeExecutionProfiling','off');
set_param(model,'CodeProfilingInstrumentation','off');
simout_sil_run2 = sim(model, 'ReturnWorkspaceOutputs', 'on');
Simulink.sdi.createRun('Run 2 (SIL mode)', 'namevalue',...
                       {'simout_sil_run2'}, {simout_sil_run2});

### Starting build procedure for: rtwdemo_sil_topmodel
### Generated code for 'rtwdemo_sil_topmodel' is up to date because no structural, parameter or code replacement library changes were found.
### Successful completion of build procedure for: rtwdemo_sil_topmodel
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Build Summary

Top model targets built:

Model                 Action         Rebuild Reason                           
==============================================================================
rtwdemo_sil_topmodel  Code compiled  Compilation artifacts were out of date.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 3.656s
### Preparing to start SIL simulation ...
### Starting SIL simulation for component: rtwdemo_sil_topmodel
### Stopping SIL simulation for component: rtwdemo_sil_topmodel
### Completed code coverage analysis

When a simulation is complete, click the link in the Command Window to open the code coverage
report and view the cumulative code coverage results. The link is available only if you have a third-
party tool installed.

Use hyperlinks in the code coverage report to go to corresponding locations in the block diagram.
Then, by using the coverage display window, you can open corresponding sections of the model
coverage report. Compare model coverage and code coverage results.

The Simulation Data Inspector opens automatically, allowing interactive viewing and analysis of the
results. Use the Compare and Inspect panes to confirm that the SIL and normal mode logged signals
are identical for both runs.

Concluding Remarks

In this example, you:

• Collected model coverage metrics during a normal mode simulation.
• Collected code coverage metrics during a SIL simulation.
• Navigated between the code coverage and model coverage reports.
• Cross-checked metrics from both reports.

See Also

Related Examples
• “Code Coverage”
• “Execution Profiling for Generated Code” on page 69-11
• “Programmatic Code Generation Verification”
• https://www.mathworks.com/products/do-178.html
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Customize Generated ASAP2 File

In this section...
“About ASAP2 File Customization” on page 84-2
“ASAP2 File Structure on the MATLAB Path” on page 84-2
“Customize the Contents of the ASAP2 File” on page 84-2
“ASAP2 Templates” on page 84-3
“Customize Computation Method Names” on page 84-5
“Suppress Computation Methods for FIX_AXIS” on page 84-5

About ASAP2 File Customization
The Embedded Coder product provides a number of Target Language Compiler (TLC) files to enable
you to customize the ASAP2 file generated from a Simulink model.

ASAP2 File Structure on the MATLAB Path
The ASAP2 related files are organized within the folders identified below:

• TLC files for generating ASAP2 file

The matlabroot/rtw/c/tlc/mw (open) folder contains TLC files that generate ASAP2 files,
asamlib.tlc, asap2lib.tlc, asap2main.tlc, and asap2grouplib.tlc. These files are
included by the setting of model configuration parameter System target file. (See “System
Target Files Supporting ASAP2” on page 61-2.)

• ASAP2 target files

The matlabroot/toolbox/rtw/targets/asap2/asap2 (open) folder contains the ASAP2
system target file and other control files.

• Customizable TLC files

The matlabroot/toolbox/rtw/targets/asap2/asap2/user (open) folder contains files that
you can modify to customize the content of your ASAP2 files.

• ASAP2 templates

The matlabroot/toolbox/rtw/targets/asap2/asap2/user/templates (open) folder
contains templates that define each type of CHARACTERISTIC in the ASAP2 file.

Customize the Contents of the ASAP2 File
The ASAP2 related TLC files enable you to customize the appearance of the ASAP2 file generated
from a Simulink model. Most customization is done by modifying or adding to the files contained in
the matlabroot/toolbox/rtw/targets/asap2/asap2/user (open) folder. This section refers to
this folder as the asap2/user folder.

The user-customizable files provided are divided into two groups:
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• The static files define the parts of the ASAP2 file that are related to the environment in which the
generated code is used. They describe information specific to the user or project. The static files
are not model dependent.

• The dynamic files define the parts of the ASAP2 file that are generated based on the structure of
the source model.

The procedure for customizing the ASAP2 file is as follows:

1 Make a copy of the asap2/user folder before making modifications.
2 Remove the old asap2/user folder from the MATLAB path, or add the new asap2/user folder

to the MATLAB path above the old folder. The MATLAB session uses the ASAP2 setup file,
asap2setup.tlc, in the new folder.

asap2setup.tlc specifies the folders and files to include in the TLC path during the ASAP2 file
generation process. Modify asap2setup.tlc to control the folders and folders included in the
TLC path.

3 Modify the static parts of the ASAP2 file. These include

• Project and header symbols, which are specified in asap2setup.tlc
• Static sections of the file, such as file header and tail, A2ML, MOD_COMMON, and so on These

are specified in asap2userlib.tlc.
• Specify the appearance of the dynamic contents of the ASAP2 file by modifying the existing

ASAP2 templates or by defining new ASAP2 templates. Sections of the ASAP2 file affected
include

RECORD_LAYOUT: modify parts of the ASAP2 template files.

CHARACTERISTIC: modify parts of the ASAP2 template files. For more information on
modifying the appearance of CHARACTERISTIC records, see “ASAP2 Templates” on page 84-
3.

• MEASUREMENT: These are specified in asap2userlib.tlc.
• COMPU_METHOD: These are specified in asap2userlib.tlc.

ASAP2 Templates
The appearance of CHARACTERISTIC records in the ASAP2 file is controlled using a different
template for each type of CHARACTERISTIC. The asap2/user folder contains template definition
files for scalars, 1-D Lookup Table blocks and 2-D Lookup Table blocks. You can modify these template
definition files, or you can create additional templates as required.

The procedure for creating a new ASAP2 template is as follows:

1 Create a template definition file. See “Create Template Definition Files” on page 84-3.
2 Include the template definition file in the TLC path. The path is specified in the ASAP2 setup file,

asap2setup.tlc.

Create Template Definition Files

This section describes the components that make up an ASAP2 template definition file. This
description is in the form of code examples from asap2lookup1d.tlc, the template definition file
for the Lookup1D template. This template corresponds to the Lookup1D parameter group.
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Note When creating a new template, use the corresponding parameter group name in place of
Lookup1D in the code shown.

Template Registration Function

The input argument is the name of the parameter group associated with this template:

%<LibASAP2RegisterTemplate("Lookup1D")>

RECORD_LAYOUT Name Definition Function

Record layout names (aliases) can be arbitrarily specified for each data type. This function is used by
the other components of this file.

%function ASAP2UserFcnRecordLayoutAlias_Lookup1D(dtId) void
  %switch dtId
  %case tSS_UINT8
    %return "Lookup1D_UBYTE"
  ...
  %endswitch
%endfunction

Function to Write RECORD_LAYOUT Definitions

This function writes RECORD_LAYOUT definitions associated with this template. The function is called
by the built-in functions involved in the ASAP2 file generation process. The function name must be
defined as shown, with the template name after the underscore:

%function ASAP2UserFcnWriteRecordLayout_Lookup1D() Output
  /begin RECORD_LAYOUT 
%<ASAP2UserFcnRecordLayoutAlias_Lookup1D(tSS_UINT8)>
    ...
  /end   RECORD_LAYOUT
%endfunction

Function to Write the CHARACTERISTIC

This function writes the CHARACTERISTIC associated with this template. The function is called by the
built-in functions involved in the ASAP2 file generation process. The function name must be defined
as shown, with the template name after the underscore.

The input argument to this function is a pointer to a parameter group record. The example shown is
for a Lookup1D parameter group that has two members. The references to the associated x and y
data records are obtained from the parameter group record as shown.

This function calls a number of built-in functions to obtain the required information. For example,
LibASAP2GetSymbol returns the symbol (name) for the specified data record:

%function ASAP2UserFcnWriteCharacteristic_Lookup1D(paramGroup) 
Output
  %assign xParam = paramGroup.Member[0].Reference
  %assign yParam = paramGroup.Member[1].Reference
  %assign dtId = LibASAP2GetDataTypeId(xParam)
    /begin CHARACTERISTIC
     /* Name */              %<LibASAP2GetSymbol(xParam)>
     /* Long identifier */   "%<LibASAP2GetLongID(xParam)>"
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     ...
    /end CHARACTERISTIC
%endfunction

Customize Computation Method Names
In generated ASAP2 files, computation methods translate the electronic control unit (ECU) internal
representation of measurement and calibration quantities into a physical model oriented
representation. Simulink Coder software provides the ability to customize the names of computation
methods. You can provide names that are more intuitive, enhancing ASAP2 file readability, or names
that meet organizational requirements.

To customize computation method names, use the MATLAB function getCompuMethodName, which is
defined in matlabroot/toolbox/rtw/targets/asap2/asap2/user/getCompuMethodName.m.

The getCompuMethodName function constructs a computation method name. The function prototype
is

cmName = getCompuMethodName(dataTypeName, cmUnits)

where dataTypeName is the name of the data type associated with the computation method,
cmUnits is the units as specified in the Unit property of a Simulink.Parameter or
Simulink.Signal object (for example, rpm or m/s), and cmName returns the constructed
computation method name.

The default constructed name returned by the function has the format

<localPrefix><datatype>_<cmUnits>

where

• <local_Prefix> is a local prefix, CM_, defined in matlabroot/toolbox/rtw/targets/
asap2/asap2/user/getCompuMethodName.m.

• <datatype> and <cmUnits> are the arguments you specified to the getCompuMethodName
function.

Additionally, in the generated ASAP2 file, the constructed name is prefixed with
<ASAP2CompuMethodName_Prefix>, a model prefix defined in matlabroot/toolbox/rtw/
targets/asap2/asap2/user/asap2setup.tlc.

For example, if you call the getCompuMethodName function with the dataTypeName argument
'int16' and the cmUnits argument 'm/s', and generate an ASAP2 file for a model named
myModel, the computation method name would appear in the generated file as follows:

/begin COMPU_METHOD
   /* Name of CompuMethod */ myModel_CM_int16_m_s
   /* Units */ "m/s"
   ...
/end COMPU_METHOD

Suppress Computation Methods for FIX_AXIS
Versions 1.51 and later of the ASAP2 specification state that for certain cases of lookup table axis
descriptions (integer data type and no doc units), a computation method is not required and the
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Conversion Method parameter must be set to the value NO_COMPU_METHOD. You can control whether
or not computation methods are suppressed when not required using the Target Language Compiler
(TLC) option ASAP2GenNoCompuMethod. This TLC option is disabled by default. If you enable the
option, ASAP2 file generation does not generate computation methods for lookup table axis
descriptions when not required, and instead generates the value NO_COMPU_METHOD. For example:

/begin CHARACTERISTIC
/* Name            */
lu1d_fix_axisTable_data
...
/begin AXIS_DESCR
    ...    
    /* Conversion Method    */
NO_COMPU_METHOD
    ...
/end CHARACTERISTIC

The ASAP2GenNoCompuMethod option is defined in matlabroot/toolbox/rtw/targets/asap2/
asap2/user/asap2setup.tlc.

See Also

Related Examples
• “How Generated Code Exchanges Data with an Environment”
• “How Generated Code Stores Internal Signal, State, and Parameter Data”
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Build Process Integration in Simulink
Coder

• “Control Build Process Compiling and Linking” on page 85-2
• “Control Library Location and Naming During Build” on page 85-3
• “Recompile Precompiled Libraries” on page 85-7
• “Customize Post-Code-Generation Build Processing” on page 85-8
• “Configure Generated Code with TLC” on page 85-13
• “Use makecfg to Customize Generated Makefiles for S-Functions” on page 85-16
• “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 85-18
• “Register Custom Toolchain and Build Executable” on page 85-22
• “Customize Build Process with STF_make_rtw_hook File” on page 85-36
• “Customize Build Process with sl_customization.m” on page 85-40
• “Replace STF_rtw_info_hook Supplied Target Data” on page 85-44
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Control Build Process Compiling and Linking
After generating code for a model, the build process determines whether to compile and link an
executable program. Various factors guide this determination:

• Generate code only option

When you select this option, the code generator produces code for the model, including a
makefile.

• Generate makefile option

When you clear this option, the code generator does not produce a makefile for the model. You
must specify post code generation processing, including compilation and linking, as a user-defined
command, as explained in “Customize Post-Code-Generation Build Processing” on page 85-8.

• Makefile-only target

The Microsoft Visual C++ Project Makefile versions of the grt and Embedded Coder target
configurations generate a Visual C++ project makefile (model.mak). To build an executable, you
must open model.mak in the Visual C++ IDE and compile and link the model code.

• HOST template makefile variable

The template makefile variable HOST identifies the type of system upon which your executable is
intended to run. The variable can be set to one of three possible values: PC, UNIX, or ANY.

By default, HOST is set to UNIX in template makefiles designed for use with The Open Group UNIX
platforms (such as grt_unix.tmf), and to PC in the template makefiles designed for use with
development systems for the PC (such as grt_vc.tmf).

If the Simulink software is running on the same type of system as the system specified by the
HOST variable, then the executable is built. Otherwise,

• If HOST = ANY, an executable is still built. This option is useful when you want to cross-
compile a program for a system other than the one that the Simulink software is running on.

• Otherwise, processing stops after generating the model code and the makefile; the following
message is displayed on the MATLAB command line.
### Make will not be invoked - template makefile is for a different host
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Control Library Location and Naming During Build
When you generate precompiled, non-precompiled, and model reference libraries, you can control the
library location and library name by using configuration parameters. These parameters control values
in generated makefiles during model builds:

• For build processes that use the toolchain approach, control the generated library location by
using the TargetPreCompLibLocation configuration parameter.

• For build processes that use the template makefile approach, control the generated library
location by using the TargetPreCompLibLocation configuration parameter and control the
generated library name by using the TargetLibSuffix configuration parameter.

Library Control Parameters
Use the library control parameters to:

• Specify the location of precompiled libraries, such as blockset libraries or the Simulink Coder
block library. Typically, a target has cross-compiled versions of these libraries and places them in a
target-specific folder.

• Control the suffix applied to library file names (for example, _target.a or _target.lib).

Targets can set the parameters inside the system target file (STF) select callback. For example:
function mytarget_select_callback_handler(varargin)
    hDig=varargin{1};
    hSrc=varargin{2};
    slConfigUISetVal(hDig, hSrc, 'TargetPreCompLibLocation',...
    'c:\mytarget\precomplibs');
    slConfigUISetVal(hDig, hSrc, 'TargetLibSuffix',...
    '_target.library');

The TMF has corresponding expansion tokens:
    |>EXPAND_LIBRARY_LOCATION<|
    |>EXPAND_LIBRARY_SUFFIX<|

Alternatively, you can use a call to the set_param function. For example:
set_param(model,'TargetPreCompLibLocation',...
'c:\mytarget\precomplibs');

Note If your model contains referenced models, you can use the make option
USE_MDLREF_LIBPATHS to control whether libraries used by the referenced models are copied to the
build folder of the parent model. For more information, see “Location of Model Reference Libraries”
on page 85-5.

Identify Library File Type for Toolchain Approach

The toolchain approach for model builds does not use the value of the TargetLibSuffix
configuration parameter to select the library file name suffix and extension.

With the toolchain approach, the final binary name is composed of the modelname, the
compilername, and the extension provided by the build tool description in the toolchain definition:
model_compilername.extension
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You can identify the static library file name extension from the build tool description in the toolchain
definition. To get this information for the default toolchain, use this procedure:

1 Get the default toolchain name. For example, enter:

tc_name = coder.make.getDefaultToolchain()
2 Get the default toolchain handle. For example, enter:

tc = coder.make.getToolchainInfoFromRegistry(tc_name)
3 Get the handle to the toolchain object. For example, enter:

tool_archiver = tc.getBuildTool('Archiver');
4 Get the extension. For example, enter:

ext_archiver = tool_archiver.getFileExtension('Static Library');

Note  If you do not set the TargetLibSuffix parameter, template makefile and toolchain
approaches produce the same static library file name extension.

Specify the Location of Precompiled Libraries
Use the TargetPreCompLibLocation configuration parameter to:

• Override the precompiled library location specified in the rtwmakecfg.m file (see “Use
rtwmakecfg.m API to Customize Generated Makefiles” on page 85-18 for details)

• Precompile and distribute target-specific versions of product libraries (for example, the DSP
System Toolbox product)

For a precompiled library, such as a blockset library or the Simulink Coder block library, the location
specified in rtwmakecfg.m is typically a location specific to the blockset or the Simulink Coder
product. The code generator expects that the library exists in this location and links against the
library during builds.

For some applications, such as custom targets, it is preferable to locate the precompiled libraries in a
target-specific or other alternate location rather than in the location specified in rtwmakecfg.m. For
a custom target, the code generator expects that the target-specific cross-compiler creates the
library, and you place the library in the target-specific location. Compile and place libraries supported
by the target in the target-specific location, so they can be used during the build process.

You can set up the TargetPreCompLibLocation parameter in its select callback. The path that you
specify for the parameter must be a fully qualified, absolute path to the library location. Relative
paths are not supported. For example:
slConfigUISetVal(hDlg, hSrc, 'TargetPreCompLibLocation',...
'c:\mytarget\precomplibs');

Alternatively, you set the parameter with a call to the set_param function. For example:
set_param(model,'TargetPreCompLibLocation',...
'c:\mytarget\precomplibs');

During makefile generation, the build process replaces the tokens with the location from the
rtwmakecfg.m file. For example, if the library name in the rtwmakecfg.m file is 'rtwlib', the
template makefile build approach expands the token from:
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LIBS += |>EXPAND_LIBRARY_LOCATION<|\|>EXPAND_LIBRARY_NAME<|\
_target.library

to:
LIBS += c:\mytarget\precomplibs\rtwlib_target.library

By default, TargetPreCompLibLocation is an empty character vector. The build process uses the
location in rtwmakecfg.m for the token replacement.

Location of Model Reference Libraries
The build process assigns a path such as ../slprj/grt/sub/sub_rtwlib.lib to
MODELREF_LINK_LIBS. The build process uses the path to gain access to the library file at link time.

Control the Suffix Applied to Library File Names
With the template makefile approach for model builds, use the TargetLibSuffix configuration
parameter to control the suffix applied to library names (for example, _target.lib or _target.a).
The specified suffix scheme must include a period (.). You can apply TargetLibSuffix to the
following libraries:

• Libraries on which a target depends, as specified in the rtwmakecfg.m API. You can use
TargetLibSuffix to change the suffix of both precompiled and non-precompiled libraries
configured from the rtwmakecfg API. For details, see “Use rtwmakecfg.m API to Customize
Generated Makefiles” on page 85-18.

In this case, a target can set the parameter in its select callback. For example:
slConfigUISetVal(hDlg, hSrc, 'TargetLibSuffix',...
'_target.library');

Alternatively, you can use a call to the set_param function. For example:
set_param(model,'TargetLibSuffix','_target.library');

During the TMF-to-makefile conversion, the build process replaces the token |
>EXPAND_LIBRARY_SUFFIX<| with the specified suffix. For example, if the library name specified
in the rtwmakecfg.m file is 'rtwlib', the TMF expands from:
LIBS += |>EXPAND_LIBRARY_LOCATION<|\|>EXPAND_LIBRARY_NAME<|\
|>EXPAND_LIBRARY_SUFFIX<|

to:
LIBS += c:\mytarget\precomplibs\rtwlib_target.library

By default, TargetLibSuffix is set to an empty character vector. In this case, the build process
replaces the token |>EXPAND_LIBRARY_SUFFIX<| with an empty character vector.

• Model libraries created with model reference. For these cases, associated makefile variables do
not require the |>EXPAND_LIBRARY_SUFFIX<| token. Instead, the build process includes
TargetLibSuffix implicitly. For example, for a top model named topmodel with referenced
models named refmodel1 and refmodel2, the TMF of the top model is expanded from:
MODELLIB           = |>MODELLIB<|
MODELREF_LINK_LIBS = |>MODELREF_LINK_LIBS<|

to:
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MODELLIB           = topmodellib_target.library
MODELREF_LINK_LIBS = \
refmodel1_rtwlib_target.library refmodel2_rtwlib_target.library

By default, the TargetLibSuffix parameter is an empty character vector. In this case, the build
process chooses a default suffix for these three tokens using a file extension of .lib on Windows
hosts and .a on UNIX hosts. For model reference libraries, the default suffix also includes
_rtwlib. For example, on a Windows host, the expanded makefile values are:
MODELLIB           = topmodellib.lib
MODELREF_LINK_LIBS = refmodel1_rtwlib.lib refmodel2_rtwlib.lib
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Recompile Precompiled Libraries
You can recompile precompiled libraries included as part of the code generator, such as rtwlib or
dsplib, by using a supplied MATLAB function, rtw_precompile_libs. You can consider
recompiling precompiled libraries to customize compiler settings for various platforms or
environments. For details on using rtw_precompile_libs, see “Precompile S-Function Libraries”
on page 56-44.
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Customize Post-Code-Generation Build Processing
The code generator provides a set of tools, including a build information object, you can use to
customize build processing that occurs after code generation. You can use such customizations for
target development or the integration of third-party tools into your application development
environment.

Workflow for Setting Up Customizations
The following figure and the steps that follow show the general workflow for setting up post-code-
generation customizations.

1 Program the post code generation command on page 85-9.
2 Define the post code generation command on page 85-10.
3 Suppress makefile generation on page 85-12, if applicable.
4 Build the model.
5 Modify the command and rebuild the model until the build results are acceptable.

Build Information Object
At the start of a model build, the build process logs the following build option and dependency
information to a temporary build information object:

• Compiler options
• Preprocessor identifier definitions
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• Linker options
• Source files and paths
• Include files and paths
• Precompiled external libraries

You can retrieve information from and add information to this object by using an extensive set of
functions. For a list of available functions and detailed function descriptions, see “Build Process
Customization”. “Program a Post Code Generation Command” on page 85-9 explains how to use
the functions to control post code generation build processing.

Program a Post Code Generation Command
For certain applications, you could want to control aspects of the build process after the code
generation. For example, you can use this approach if you develop your own target, or you want to
apply an analysis tool to the generated code before continuing with the build process. You can apply
this level of control to the build process by programming and then defining a post code generation
command.

A post code generation command is a MATLAB language file that typically calls functions that get
data from or add data to the build information object of the model. You can program the command as
a script or function.

If you program the command as
a:

Then the:

Script Script can gain access to the model name and the build
information directly

Function Function can pass the model name and the build information
as arguments

If your post code generation command calls user-defined functions, make sure that the functions are
on the MATLAB path. If the build process cannot find a function you use in your command, the build
process errors out.

You can then call a combination of build information functions, as listed in “Build Process
Customization”, to customize the post code generation build processing of the model.

The following example shows a fragment of a post code generation command that gets the file names
and paths of the source and include files generated for a model for analysis.
function analyzegencode(buildInfo)
% Get the names and paths of source and include files
% generated for the model and then analyze them.

% buildInfo - build information for my model.

% Define cell array to hold data.
MyBuildInfo={};

% Get source file information.
MyBuildInfo.srcfiles=getSourceFiles(buildInfo, true, true);
MyBuildInfo.srcpaths=getSourcePaths(buildInfo, true);

% Get include (header) file information.
MyBuildInfo.incfiles=getIncludeFiles(buildInfo, true, true);
MyBuildInfo.incpaths=getIncludePaths(buildInfo, true);
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% Analyze generated code.
.
.
.

Define a Post Code Generation Command
After you program a post code generation command, inform the build process that the command
exists and to add it to the build processing of the model. Define the command with the
PostCodeGenCommand model configuration parameter. When you define a post code generation
command, the build process evaluates the command after generating and writing the generated code
to disk and before generating a makefile.

As the following syntax lines show, the arguments that you specify when setting the configuration
parameter varies depending on whether you program the command as a script, function, or set of
functions.

Note When defining the command as a function, you can specify an arbitrary number of input
arguments. To pass the name and build information of the model to the function, specify identifiers
modelName and buildInfo as arguments.

Script
set_param(model, 'PostCodeGenCommand',...
'pcgScriptName');

Function
set_param(model, 'PostCodeGenCommand',...
 'pcgFunctionName(modelName)');

Multiple Functions
pcgFunctions=...
'pcgFunction1Name(modelName);...
pcgFunction2Name(buildInfo)';
set_param(model, 'PostCodeGenCommand',...
 pcgFunctions);

The following call to set_param defines PostCodGenCommand to evaluate the function
analyzegencode.

set_param(model, 'PostCodeGenCommand',...
'analyzegencode(buildInfo)');

Customize Build Process with PostCodeGenCommand and Relocate
Generated Code to an External Environment
This example shows how to use the build information programming interface and the model
configuration parameter Post code generation command (PostCodeGenCommand) to customize
the build process. For this example, Post code generation command is set to
rtwdemo_buildinfo_data. The build process invokes that function after code generation.

The example also shows how to use build configuration function rtwmakecfg.m.
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Open Example Model

Open the example model rtwdemo_buildinfo.

open_system('rtwdemo_buildinfo');

Generate Code from Model

Generate code. The code generator produces the file BuildInfo.html, which documents the build
information object.

Examine the Build Process Customizations and Output

Examine the build process customizations and the post code generation query of the build
information object. In a Web browser, open the file BuildInfo.html. The file provides hyperlinks
that you can use to examine the code produced for the model. Alternatively, in the MATLAB Command
Window:

• To view the function configured to execute during the post code generation stage of the build
process, enter:

get_param('rtwdemo_buildinfo','PostCodeGenCommand');

• To study the programming interface for the build information object, enter:

rtwdemo_buildinfo_data(buildInfo);

• To study how the example uses the rtwmakecfg function, enter:

edit rtwmakecfg.m;

• To view the build information object data that the build process saves in the buildInfo.mat file,
open the file rtwdemo_<target>_rtw\buildInfo.mat.

• To view the contents of the post code generation function rtwdemo_buildinfo_data.m, enter:
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edit rtwdemo_buildinfo_data.m;

At the end of the file, the function calls packNGo to package the source and object files that the build
information object identifies for relocation.

Related Topics

• “Build Process Customization”
• “Customize Post-Code-Generation Build Processing”
• “Use rtwmakecfg.m API to Customize Generated Makefiles”
• “Relocate Code to Another Development Environment”

Suppress Makefile Generation
The code generator lets you suppress makefile generation during the build process. For example, you
can use this support when you integrate tools into the build process that do not use makefiles.

To instruct the code generator not to produce a makefile, do one of the following:

• Clear the Generate makefile option on the Code Generation pane of the Configuration
Parameters dialog box.

• Set the value of the configuration parameter GenerateMakefile to off.

When you suppress makefile generation,

• You cannot explicitly specify a make command or template makefile.
• Specify your own instructions for a post code generation processing, including compilation and

linking, in a post code generation command as explained in “Program a Post Code Generation
Command” on page 85-9 and “Define a Post Code Generation Command” on page 85-10.

See Also
RTW.BuildInfo
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Configure Generated Code with TLC
You can use the Target Language Compiler (TLC) to fine-tune your generated code. TLC supports
extended code generation variables and options in addition to parameters available on the Code
Generation pane on the Configuration Parameters dialog box. There are two ways to set TLC
variables and options, as described in this section.

Note Do not customize TLC files in the folder matlabroot/rtw/c/tlc even though the capability
exists to do so. It is possible that such TLC customizations are not applied during the code generation
process. Such customizations can lead to unpredictable results.

Assigning Target Language Compiler Variables
The %assign statement lets you assign a value to a TLC variable, as in:
%assign MaxStackSize = 4096

This assignment is also known as creating a parameter name/parameter value pair.

For a description of the %assign statement, see “Target Language Compiler Directives”. Write your
%assign statements in the Configure RTW code generation settings section of the system
target file.

The following table lists the code generation variables you can set with the %assign statement.
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Target Language Compiler Optional Variables  

Variable Description
MaxStackSize=N When the Enable local block outputs check box is selected, the

total allocation size of local variables that are declared by block
outputs in the model cannot exceed MaxStackSize (in bytes).
MaxStackSize can be a positive integer. If the total size of local
block output variables exceeds this maximum, the remaining block
output variables are allocated in global, rather than local, memory.
The default value for MaxStackSize is rtInf, that is, unlimited
stack size.

Note: Local variables in the generated code from sources other
than local block outputs, such as from a Stateflow diagram or
MATLAB Function block, and stack usage from sources such as
function calls and context switching are not included in the
MaxStackSize calculation. For overall executable stack usage
metrics, do a target-specific measurement by using run-time
(empirical) analysis or static (code path) analysis with object code.

MaxStackVariableSize=N When the Enable local block outputs check box is selected, this
selection limits the size of a local block output variable declared in
the code to N bytes, where N>0. A variable whose size exceeds
MaxStackVariableSize is allocated in global, rather than local,
memory. The default is 4096.

RemoveFixptWordSizeChecks=value For a model that uses fixed-point data types, control the generation
of preprocessor directives that perform fixed-point word size
checks. If value is:

• 0, generate the preprocessor directives. The generated code
contains fixed-point word size checks.

• 1, suppress the generation of the preprocessor directives. The
generated code does not contain fixed-point word size checks.

You can also suppress the generation of the preprocessor directives
by running this command:

set_param(gcs, 'TLCOptions', ...
          '-aRemoveFixptWordSizeChecks=1')

If you generate code that does not contain the fixed-point word size
checks, you can use processor-in-the-loop (PIL) simulations that
check Hardware Implementation settings with reference to the
target hardware. For more information, see “Verification of Code
Generation Assumptions” on page 80-62.
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Variable Description
WarnNonSaturatedBlocks=value Flag to control display of overflow warnings for blocks that have

saturation capability, but have it turned off (not selected) in their
dialog box. Options include:

• 0 — Warning is not displayed.
• 1 — Displays one warning for the model during code generation
• 2 — Displays one warning that contains a list of offending

blocks

Set Target Language Compiler Options
You can specify TLC command-line options for code generation using the model parameter
TLCOptions in a set_param function call. For information about these options, see “Specify TLC for
Code Generation” and “Configure TLC”.

See Also

Related Examples
• “Target Language Compiler Directives”
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Use makecfg to Customize Generated Makefiles for S-Functions
With the toolchain or template makefile approach for building code, you can customize generated
makefiles for S-functions. Through the customization, you can specify additional items for the S-
function build process:

• Source files and folders
• Include files and folders
• Library names
• Preprocessor macro definitions
• Compiler flags
• Link objects

To customize the generated makefile:

1 In the S-function MEX file folder that contains your S-function components, create a makecfg.m
or specificSFunction_makecfg.m file. If you create a makecfg.m file, it is active for any S-
function in the S-function MEX file folder that the model uses. A
specificSFunction_makecfg.m file is active only if the model uses the corresponding S-
function.

2 In the file that you create, use RTW.BuildInfo functions to specify additional items for the S-
function build process. For example, you can use:

• addCompileFlags to specify compiler options.
• addDefines to specify preprocessor macro definitions.

3 Save the created file.

After code generation, in the S-function MEX file folder, the code generator searches for makecfg.m
and specificSFunction_makecfg.m files. If the files are present, the code generator uses these
files to customize the generated makefile, model.mk.

For example, consider a folder that contains signalConvert.mexa64 (S-function binary file) and
signalConvert.tlc (inlined S-function implementation) after the TLC phase of the build process.
The S-function requires an additional source code file, filterV1.c, which is located in
anotherFolder. You can create a file, signalConvert_makecfg.m, that uses RTW.BuildInfo
functions to specify filterV1.c for the build process.

function signalConvert_makecfg(objBuildInfo)

absolute = fullfile('$(START_DIR)', 'anotherFolder');

addIncludePaths(objBuildInfo, absolute);
addSourcePaths(objBuildInfo, absolute);
addSourceFiles(objBuildInfo,'filterV1.c');

See Also

Related Examples
• “Build Process Workflow for Real-Time Systems”
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• “Choose Build Approach and Configure Build Process”
• “Import Calls to External Code into Generated Code with Legacy Code Tool”
• “Use rtwmakecfg.m API to Customize Generated Makefiles”
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Use rtwmakecfg.m API to Customize Generated Makefiles
Both the toolchain approach and the template makefile approach for builds let you add the following
items to generated makefiles:

• Source folders
• Include folders
• Library names
• Module objects

About the rtwmakecfg Function
Using an rtwmakecfg function, you add this information to the makefile during the build operation
for S-functions. The rtwmakecfg function is useful when specifying added sources and libraries to
build a model that contains one or more of your S-function blocks.

To add information pertaining to an S-function to the makefile:

1 Create the MATLAB language rtwmakecfg function in the rtwmakecfg.m file. The code
generator associates this file with your S-function based on its folder location. “Create the
rtwmakecfg Function” on page 85-18 describes the requirements for the rtwmakecfg function
and the data it returns.

2 If you are using the template makefile approach, modify the TMF of your target such that it
supports macro expansion for the information that the rtwmakecfg function returns. “Modify
the Template Makefile for rtwmakecfg” on page 85-20 describes the required modifications. If
you are using the toolchain approach, the information that the rtwmakecfg function returns is
used by the generated makefile; no further configuration is required.

After the TLC phase of the build process, when generating a makefile, the code generator searches
for an rtwmakecfg.m file in the folder that contains the S-function MEX file. If it finds the file, the
build process calls the rtwmakecfg function.

Create the rtwmakecfg Function
Create the rtwmakecfg.m file containing the rtwmakecfg function in the same folder as your S-
function component (a MEX-file with a platform-dependent extension, such as .mexext on Microsoft
Windows systems). The function must return a structured array that contains these fields.

Field Description
makeInfo.includePath A cell array that specifies additional include folder names, organized

as a row vector. The build process expands the folder names into
include instructions in the generated makefile.

makeInfo.sourcePath A cell array that specifies additional source folder names, organized
as a row vector. Include the folder names of files entered into the S-
function modules field on the S-Function Block Parameters dialog
box or into the SFunctionModules parameter of the block if they
are not in the same folder as the S-function. The build process
expands the folder names into make rules in the generated makefile.
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Field Description
makeInfo.sources A cell array that specifies additional source file names (C or C++),

organized as a row vector. Do not include the name of the S-function
or files entered into the S-function modules field on the S-Function
Block Parameters dialog box or into the SFunctionModules
parameter of the block. The build process expands the file names into
make variables that contain the source files. Specify only file names
(with extension). Specify path information with the sourcePath
field.

makeInfo.linkLibsObjs A cell array that specifies additional, fully qualified paths to object or
library files against which the generated code links. The build
process does not compile the specified objects and libraries.
However, it includes them when linking the final executable. This
inclusion can be useful for incorporating libraries that you do not
want the build process to recompile or for which the source files are
not available. You can also use this element to integrate source files
from languages other than C and C++. This integration is possible if
you first create a C compatible object file or library outside of the
build process.

makeInfo.precompile A Boolean flag that indicates whether the libraries specified in the
rtwmakecfg.m file exist in a specified location (precompile==1) or
if you must create the libraries in the build folder during the build
process (precompile==0).

makeInfo.library A structure array that specifies additional run-time libraries and
module objects, organized as a row vector. The build process expands
the information into make rules in the generated makefile. For a list
of the library fields, see the next table.

The makeInfo.library field consists of the following elements.

Element Description
makeInfo.library(n).Name A character array that specifies the name of the library (without

an extension).
makeInfo.library(n).Location A character array that specifies the folder in which the library is

located when precompiled. For more information, see the
description of makeInfo.precompile in the preceding table. A
target can use the TargetPreCompLibLocation parameter to
override this value. See “Specify the Location of Precompiled
Libraries”.

makeInfo.library(n).Modules A cell array that specifies the C or C++ source file base names
(without an extension) that comprise the library. Do not include
the file extension. The makefile appends the object extension.

Note The makeInfo.library field must fully specify each library and how to build it. The modules
list in the makeInfo.library(n).Modules element cannot be empty. To specify a link-only library,
use the makeInfo.linkLibsObjs field instead.

Example:
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 disp(['Running rtwmakecfg from folder: ',pwd]);
    makeInfo.includePath = { fullfile(pwd, 'somedir2') };
    makeInfo.sourcePath = {fullfile(pwd, 'somedir2'), fullfile(pwd, 'somedir3')};
    makeInfo.sources  = { 'src1.c', 'src2.cpp'};
    makeInfo.linkLibsObjs = { fullfile(pwd, 'somedir3', 'src3.object'),...
                              fullfile(pwd, 'somedir4', 'mylib.library')};
    makeInfo.precompile = 1;
    makeInfo.library(1).Name     = 'myprecompiledlib';
    makeInfo.library(1).Location = fullfile(pwd,'somdir2','lib');
    makeInfo.library(1).Modules  = {'srcfile1' 'srcfile2' 'srcfile3' };

Note If a path that you specify in the rtwmakecfg.m API contains spaces, the build process does not
convert the path to its nonspace equivalent. If the build environments you intend to support do not
support spaces in paths, refer to “Build Process Support for Folder Names with Spaces or Special
Characters”.

Modify the Template Makefile for rtwmakecfg
To expand the information that an rtwmakecfg function generates, modify the following sections in
the TMF of your target:

• Include Path
• C Flags and/or Additional Libraries
• Rules

It is possible that these TMF code examples do not apply to your make utility. For additional
examples, see the GRT or ERT TMFs located in matlabroot/toolbox/coder/compile/tmf.

Add Folder Names to the Makefile Include Path

The following TMF code example adds folder names to the include path in the generated makefile:
ADD_INCLUDES = \
|>START_EXPAND_INCLUDES<|   -I|>EXPAND_DIR_NAME<| \
|>END_EXPAND_INCLUDES<|

Also, the ADD_INCLUDES macro must be added to the INCLUDES line.
INCLUDES = -I. -I.. $(ADD_INCLUDES) $(USER_INCLUDES)

Add Library Names to the Makefile

The following TMF code example adds library names to the generated makefile.
LIBS =
|>START_PRECOMP_LIBRARIES<|
LIBS += |>EXPAND_LIBRARY_NAME<|.a |>END_PRECOMP_LIBRARIES<|
|>START_EXPAND_LIBRARIES<|
LIBS += |>EXPAND_LIBRARY_NAME<|.a |>END_EXPAND_LIBRARIES<|

For more information, see “Control Library Location and Naming During Build” on page 85-3.

Add Rules to the Makefile

The TMF code example adds rules to the generated makefile.
|>START_EXPAND_RULES<|
$(BLD)/%.o: |>EXPAND_DIR_NAME<|/%.c $(SRC)/$(MAKEFILE) rtw_proj.tmw
    @$(BLANK)
    @echo ### "|>EXPAND_DIR_NAME<|\$*.c"
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    $(CC) $(CFLAGS) $(APP_CFLAGS) -o $(BLD)$(DIRCHAR)$*.o \
    |>EXPAND_DIR_NAME<|$(DIRCHAR)$*.c > $(BLD)$(DIRCHAR)$*.lst
|>END_EXPAND_RULES<|

|>START_EXPAND_LIBRARIES<|MODULES_|>EXPAND_LIBRARY_NAME<| = \
|>START_EXPAND_MODULES<|    |>EXPAND_MODULE_NAME<|.o \
|>END_EXPAND_MODULES<|

|>EXPAND_LIBRARY_NAME<|.a : $(MAKEFILE) rtw_proj.tmw
$(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
    @$(BLANK)
    @echo ### Creating $@
    $(AR) -r $@ $(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
|>END_EXPAND_LIBRARIES<|

|>START_PRECOMP_LIBRARIES<|MODULES_|>EXPAND_LIBRARY_NAME<| = \
|>START_EXPAND_MODULES<|    |>EXPAND_MODULE_NAME<|.o \
|>END_EXPAND_MODULES<|

|>EXPAND_LIBRARY_NAME<|.a : $(MAKEFILE) rtw_proj.tmw
$(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
    @$(BLANK)
    @echo ### Creating $@
    $(AR) -r $@ $(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
|>END_PRECOMP_LIBRARIES<|
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Register Custom Toolchain and Build Executable
This example shows how to register and use a toolchain to build an executable file. This example uses
the Intel® compiler. However, the concepts and programming interface apply for other toolchains.
Once you register a toolchain, you can configure a model such that the code generator uses the
toolchain to build an executable file for the model.

Toolchain

A toolchain is a collection of tools required to compile and link code for a specified platform. A
toolchain consists of multiple tools, such as a compiler, linker, and archiver. You can configure the
tools in a toolchain with multiple options and group tool specifications into types of configurations.

Create a New Folder and Copy Relevant Files

The following code creates a folder in your current working folder (pwd). The new folder contains
files for this example. If you do not want to affect the current folder, or cannot generate files in this
folder, change your working folder before invoking the command.

copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','toolchain_demo'),'toolchain_demo','f')
cd toolchain_demo

Open a Model

Open the rtwdemo_counter model. By default, this model is configured to use the Generic Real-
Time Target (GRT) configuration and the toolchain approach for building an executable file. The
capability demonstrated in this example is available for models configured to use the toolchain
approach.

model = 'rtwdemo_counter';
open_system(model)
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Choose a Toolchain

Open the Configuration Parameters dialog box. Select Code Generation. The Toolchain settings
section contains parameters for configuring a toolchain. From the Toolchain drop-down list, select
the toolchain installed on your development system for building an executable file from the code
generated from your model.

By default, the Faster Runs build configuration is selected. Click Show settings to see the toolchain
flags specified for building the generated code. Choose a build configuration based on your current
application development goal.

Close the Configuration Parameters dialog box.

Create a ToolchainInfo Object

This example shows how you can register a custom toolchain and add it as a selectable Toolchain
option.

The first step to registering a custom toolchain is to create a ToolchainInfo object that contains
information about the toolchain. Methods are available to set toolchain specifications. You can share a
ToolchainInfo object across installations.

Open the toolchain definition file for an Intel compiler. This file creates a ToolchainInfo object that
contains information about the Intel toolchain on a 64-bit Windows® platform.

edit intel_tc
type intel_tc

function tc = intel_tc
%INTEL_TC Creates an Intel v18 ToolchainInfo object.
% This file can be used as a template to define other toolchains on Windows.

% Copyright 2012-2019 The MathWorks, Inc.

tc = coder.make.ToolchainInfo('BuildArtifact', 'nmake makefile');
tc.Name             = 'Intel v18 | nmake makefile (64-bit Windows)';
tc.Platform         = 'win64';
tc.SupportedVersion = '18';

tc.addAttribute('TransformPathsWithSpaces');
tc.addAttribute('RequiresCommandFile');
tc.addAttribute('RequiresBatchFile');

% ------------------------------
% Setup
% ------------------------------
% Below we are using %ICPP_COMPILER18% as root folder where Intel Compiler is installed.
% You can either set an environment variable or give full path to the
% compilervars.bat file
tc.ShellSetup{1} = 'call %ICPP_COMPILER18%\bin\compilervars.bat intel64';

% ------------------------------
% Macros
% ------------------------------
tc.addMacro('MW_EXTERNLIB_DIR',     ['$(MATLAB_ROOT)\extern\lib\' tc.Platform '\microsoft']);
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tc.addMacro('MW_LIB_DIR',           ['$(MATLAB_ROOT)\lib\' tc.Platform]);
tc.addMacro('CFLAGS_ADDITIONAL',    '-D_CRT_SECURE_NO_WARNINGS');
tc.addMacro('CPPFLAGS_ADDITIONAL',  '-EHs -D_CRT_SECURE_NO_WARNINGS');
tc.addMacro('LIBS_TOOLCHAIN',       '$(conlibs)');
tc.addMacro('CVARSFLAG',            '');

tc.addIntrinsicMacros({'ldebug', 'conflags', 'cflags'});

% ------------------------------
% C Compiler
% ------------------------------
 
tool = tc.getBuildTool('C Compiler');

tool.setName(           'Intel C Compiler');
tool.setCommand(        'icl');
tool.setPath(           '');

tool.setDirective(      'IncludeSearchPath',    '-I');
tool.setDirective(      'PreprocessorDefine',   '-D');
tool.setDirective(      'OutputFlag',           '-Fo');
tool.setDirective(      'Debug',                '-Zi');

tool.setFileExtension(  'Source',               '.c');
tool.setFileExtension(  'Header',               '.h');
tool.setFileExtension(  'Object',               '.obj');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% C++ Compiler
% ------------------------------

tool = tc.getBuildTool('C++ Compiler');

tool.setName(           'Intel C++ Compiler');
tool.setCommand(        'icl');
tool.setPath(           '');

tool.setDirective(      'IncludeSearchPath',      '-I');
tool.setDirective(      'PreprocessorDefine',     '-D');
tool.setDirective(      'OutputFlag',           '-Fo');
tool.setDirective(      'Debug',                '-Zi');

tool.setFileExtension(  'Source',               '.cpp');
tool.setFileExtension(  'Header',               '.hpp');
tool.setFileExtension(  'Object',               '.obj');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% Linker
% ------------------------------

tool = tc.getBuildTool('Linker');

tool.setName(           'Intel C/C++ Linker');
tool.setCommand(        'xilink');
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tool.setPath(           '');

tool.setDirective(      'Library',              '-L');
tool.setDirective(      'LibrarySearchPath',    '-I');
tool.setDirective(      'OutputFlag',           '-out:');
tool.setDirective(      'Debug',                '');

tool.setFileExtension(  'Executable',           '.exe');
tool.setFileExtension(  'Shared Library',       '.dll');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% C++ Linker
% ------------------------------

tool = tc.getBuildTool('C++ Linker');

tool.setName(           'Intel C/C++ Linker');
tool.setCommand(        'xilink');
tool.setPath(           '');

tool.setDirective(      'Library',              '-L');
tool.setDirective(      'LibrarySearchPath',    '-I');
tool.setDirective(      'OutputFlag',           '-out:');
tool.setDirective(      'Debug',                '');

tool.setFileExtension(  'Executable',           '.exe');
tool.setFileExtension(  'Shared Library',       '.dll');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% Archiver
% ------------------------------

tool = tc.getBuildTool('Archiver');

tool.setName(           'Intel C/C++ Archiver');
tool.setCommand(        'xilib');
tool.setPath(           '');
tool.setDirective(      'OutputFlag',           '-out:');
tool.setFileExtension(  'Static Library',       '.lib');
tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% Builder
% ------------------------------

tc.setBuilderApplication(tc.Platform);

% --------------------------------------------
% BUILD CONFIGURATIONS
% --------------------------------------------

optimsOffOpts    = {'/c /Od'};
optimsOnOpts     = {'/c /O2'};
cCompilerOpts    = '$(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL)';
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cppCompilerOpts  = '$(cflags) $(CVARSFLAG) $(CPPFLAGS_ADDITIONAL)';
linkerOpts       = {'$(ldebug) $(conflags) $(LIBS_TOOLCHAIN)'};
sharedLinkerOpts = horzcat(linkerOpts, '-dll -def:$(DEF_FILE)');
archiverOpts     = {'/nologo'};

% Get the debug flag per build tool
debugFlag.CCompiler   = '$(CDEBUG)';   
debugFlag.CppCompiler = '$(CPPDEBUG)';
debugFlag.Linker      = '$(LDDEBUG)';  
debugFlag.CppLinker   = '$(CPPLDDEBUG)';  
debugFlag.Archiver    = '$(ARDEBUG)';  

% Set the toolchain flags for 'Faster Builds' build configuration

cfg = tc.getBuildConfiguration('Faster Builds');
cfg.setOption( 'C Compiler',                horzcat(cCompilerOpts,   optimsOffOpts));
cfg.setOption( 'C++ Compiler',              horzcat(cppCompilerOpts, optimsOffOpts));
cfg.setOption( 'Linker',                    linkerOpts);
cfg.setOption( 'C++ Linker',                linkerOpts);
cfg.setOption( 'Shared Library Linker',     sharedLinkerOpts);
cfg.setOption( 'Archiver',                  archiverOpts);

% Set the toolchain flags for 'Faster Runs' build configuration

cfg = tc.getBuildConfiguration('Faster Runs');
cfg.setOption( 'C Compiler',                horzcat(cCompilerOpts,   optimsOnOpts));
cfg.setOption( 'C++ Compiler',              horzcat(cppCompilerOpts, optimsOnOpts));
cfg.setOption( 'Linker',                    linkerOpts);
cfg.setOption( 'C++ Linker',                linkerOpts);
cfg.setOption( 'Shared Library Linker',     sharedLinkerOpts);
cfg.setOption( 'Archiver',                  archiverOpts);

% Set the toolchain flags for 'Debug' build configuration

cfg = tc.getBuildConfiguration('Debug');
cfg.setOption( 'C Compiler',                  horzcat(cCompilerOpts,   optimsOffOpts, debugFlag.CCompiler));
cfg.setOption( 'C++ Compiler',              horzcat(cppCompilerOpts, optimsOffOpts, debugFlag.CppCompiler));
cfg.setOption( 'Linker',                    horzcat(linkerOpts,       debugFlag.Linker));
cfg.setOption( 'C++ Linker',                   horzcat(linkerOpts,       debugFlag.CppLinker));
cfg.setOption( 'Shared Library Linker',      horzcat(sharedLinkerOpts, debugFlag.Linker));
cfg.setOption( 'Archiver',                  horzcat(archiverOpts,     debugFlag.Archiver));

tc.setBuildConfigurationOption('all', 'Make Tool',     '-f $(MAKEFILE)');

You can display the errors and warnings in the diagnostics messages pane from builds generated by
custom compilers. For more information, see “Diagnostic Message Pane”.

Run the toolchain definition file to generate the ToolchainInfo object.

tc = intel_tc;

Save the ToolchainInfo object tc to a MAT file.

save intel_tc tc
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Register the Custom Toolchain

After you create the ToolchainInfo object for the new toolchain, register it. Register a toolchain in
RTW.TargetRegistry. To register the toolchain, write an rtwTargetInfo.m file. Then, add that
file to the MATLAB path so the system loads it automatically.

type rtwTargetInfo

function rtwTargetInfo(tr)
%RTWTARGETINFO Registration file for custom toolchains.

% Copyright 2012-2019 The MathWorks, Inc.

tr.registerTargetInfo(@loc_createToolchain);

end

% -------------------------------------------------------------------------
% Create the ToolchainInfoRegistry entries
% -------------------------------------------------------------------------
function config = loc_createToolchain

config(1)                       = coder.make.ToolchainInfoRegistry;
config(1).Name                  = 'Intel v18 | nmake makefile (64-bit Windows)';
config(1).FileName              = fullfile(fileparts(mfilename('fullpath')), 'intel_tc.mat');
config(1).TargetHWDeviceType    = {'*'};
config(1).Platform              =  {computer('arch')};

end

Reset the TargetRegistry to use the new rtwTargetInfo.m file.

RTW.TargetRegistry.getInstance('reset');

Choose the Custom Toolchain

Reopen the Configuration Parameters dialog box. Click Toolchain. You should see the new
toolchain in the list. Select the Intel v18 toolchain.

Programmatically, you can accomplish the same task with the following commands:

cs = getActiveConfigSet(model);
set_param(cs, 'Toolchain', tc.Name)

Verify your selection.

toolchain = get_param(cs, 'Toolchain')

toolchain =

    'Intel v18 | nmake makefile (64-bit Windows)'

Build the Model Using the Custom Toolchain

You can now build the model with the new custom toolchain.

 Register Custom Toolchain and Build Executable

85-27



Note: If you do not have the Intel toolchain installed, you can use the following command to generate
the code and makefile only.

set_param(cs, 'GenCodeOnly', 'on')

Build the model to generate the code and makefile that uses the new toolchain.

slbuild(model)

### Starting build procedure for: rtwdemo_counter
### Successful completion of code generation for: rtwdemo_counter

Build Summary

Top model targets built:

Model            Action          Rebuild Reason                                    
===================================================================================
rtwdemo_counter  Code generated  Code generation information file does not exist.  

1 of 1 models built (0 models already up to date)
Build duration: 0h 0m 26.094s

Obtain the build directory information.

dirInfo = RTW.getBuildDir(model);

Examine the generated makefile.

type(fullfile(dirInfo.BuildDirectory, [model '.mk']))

###########################################################################
## Makefile generated for component 'rtwdemo_counter'. 
## 
## Makefile     : rtwdemo_counter.mk
## Generated on : Mon Jan 11 20:31:42 2021
## Final product: $(RELATIVE_PATH_TO_ANCHOR)\rtwdemo_counter.exe
## Product type : executable
## 
###########################################################################

###########################################################################
## MACROS
###########################################################################

# Macro Descriptions:
# PRODUCT_NAME            Name of the system to build
# MAKEFILE                Name of this makefile
# COMPILER_COMMAND_FILE   Compiler command listing model reference header paths
# CMD_FILE                Command file

PRODUCT_NAME              = rtwdemo_counter
MAKEFILE                  = rtwdemo_counter.mk
MATLAB_ROOT               = D:\JOBARC~1\Bdoc21a\2W09AA~J\matlab
MATLAB_BIN                = D:\JOBARC~1\Bdoc21a\2W09AA~J\matlab\bin
MATLAB_ARCH_BIN           = $(MATLAB_BIN)\win64
START_DIR                 = C:\Users\johnr\ONEDRI~1\DOCUME~1\MATLAB\Examples\SIMULI~1\TOOLCH~1
SOLVER                    = 
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SOLVER_OBJ                = 
CLASSIC_INTERFACE         = 0
TGT_FCN_LIB               = None
MODEL_HAS_DYNAMICALLY_LOADED_SFCNS = 0
RELATIVE_PATH_TO_ANCHOR   = ..
COMPILER_COMMAND_FILE     = rtwdemo_counter_comp.rsp
CMD_FILE                  = rtwdemo_counter.rsp
C_STANDARD_OPTS           = 
CPP_STANDARD_OPTS         = 

###########################################################################
## TOOLCHAIN SPECIFICATIONS
###########################################################################

# Toolchain Name:          Intel v18 | nmake makefile (64-bit Windows)
# Supported Version(s):    18
# ToolchainInfo Version:   2021a
# Specification Revision:  1.0
# 
#-------------------------------------------
# Macros assumed to be defined elsewhere
#-------------------------------------------

# ldebug
# conflags
# cflags

#-----------
# MACROS
#-----------

MW_EXTERNLIB_DIR    = $(MATLAB_ROOT)\extern\lib\win64\microsoft
MW_LIB_DIR          = $(MATLAB_ROOT)\lib\win64
CFLAGS_ADDITIONAL   = -D_CRT_SECURE_NO_WARNINGS
CPPFLAGS_ADDITIONAL = -EHs -D_CRT_SECURE_NO_WARNINGS
LIBS_TOOLCHAIN      = $(conlibs)

TOOLCHAIN_SRCS = 
TOOLCHAIN_INCS = 
TOOLCHAIN_LIBS = 

#------------------------
# BUILD TOOL COMMANDS
#------------------------

# C Compiler: Intel C Compiler
CC = icl

# Linker: Intel C/C++ Linker
LD = xilink

# C++ Compiler: Intel C++ Compiler
CPP = icl

# C++ Linker: Intel C/C++ Linker
CPP_LD = xilink

# Archiver: Intel C/C++ Archiver
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AR = xilib

# MEX Tool: MEX Tool
MEX_PATH = $(MATLAB_ARCH_BIN)
MEX = "$(MEX_PATH)\mex"

# Download: Download
DOWNLOAD =

# Execute: Execute
EXECUTE = $(PRODUCT)

# Builder: NMAKE Utility
MAKE = nmake

#-------------------------
# Directives/Utilities
#-------------------------

CDEBUG              = -Zi
C_OUTPUT_FLAG       = -Fo
LDDEBUG             =
OUTPUT_FLAG         = -out:
CPPDEBUG            = -Zi
CPP_OUTPUT_FLAG     = -Fo
CPPLDDEBUG          =
OUTPUT_FLAG         = -out:
ARDEBUG             =
STATICLIB_OUTPUT_FLAG = -out:
MEX_DEBUG           = -g
RM                  = @del
ECHO                = @echo
MV                  = @ren
RUN                 = @cmd /C

#----------------------------------------
# "Faster Builds" Build Configuration
#----------------------------------------

ARFLAGS              = /nologo
CFLAGS               = $(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL) \
                       /c /Od
CPPFLAGS             = $(cflags) $(CVARSFLAG) $(CPPFLAGS_ADDITIONAL) \
                       /c /Od
CPP_LDFLAGS          = $(ldebug) $(conflags) $(LIBS_TOOLCHAIN)
CPP_SHAREDLIB_LDFLAGS  =
DOWNLOAD_FLAGS       =
EXECUTE_FLAGS        =
LDFLAGS              = $(ldebug) $(conflags) $(LIBS_TOOLCHAIN)
MEX_CPPFLAGS         =
MEX_CPPLDFLAGS       =
MEX_CFLAGS           =
MEX_LDFLAGS          =
MAKE_FLAGS           = -f $(MAKEFILE)
SHAREDLIB_LDFLAGS    = $(ldebug) $(conflags) $(LIBS_TOOLCHAIN) \
                       -dll -def:$(DEF_FILE)
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###########################################################################
## OUTPUT INFO
###########################################################################

PRODUCT = $(RELATIVE_PATH_TO_ANCHOR)\rtwdemo_counter.exe
PRODUCT_TYPE = "executable"
BUILD_TYPE = "Top-Level Standalone Executable"

###########################################################################
## INCLUDE PATHS
###########################################################################

INCLUDES_BUILDINFO = 

INCLUDES = $(INCLUDES_BUILDINFO)

###########################################################################
## DEFINES
###########################################################################

DEFINES_BUILD_ARGS = -DCLASSIC_INTERFACE=0 -DALLOCATIONFCN=0 -DTERMFCN=0 -DONESTEPFCN=1 -DMAT_FILE=0 -DMULTI_INSTANCE_CODE=0 -DINTEGER_CODE=0 -DMT=0
DEFINES_CUSTOM = 
DEFINES_OPTS = -DTID01EQ=0
DEFINES_STANDARD = -DMODEL=rtwdemo_counter -DNUMST=1 -DNCSTATES=0 -DHAVESTDIO -DMODEL_HAS_DYNAMICALLY_LOADED_SFCNS=0

DEFINES = $(DEFINES_BUILD_ARGS) $(DEFINES_CUSTOM) $(DEFINES_OPTS) $(DEFINES_STANDARD)

###########################################################################
## SOURCE FILES
###########################################################################

SRCS = $(START_DIR)\rtwdemo_counter_ert_rtw\rtwdemo_counter.c

MAIN_SRC = $(START_DIR)\rtwdemo_counter_ert_rtw\ert_main.c

ALL_SRCS = $(SRCS) $(MAIN_SRC)

###########################################################################
## OBJECTS
###########################################################################

OBJS = rtwdemo_counter.obj

MAIN_OBJ = ert_main.obj

ALL_OBJS = $(OBJS) $(MAIN_OBJ)

###########################################################################
## PREBUILT OBJECT FILES
###########################################################################

PREBUILT_OBJS = 

###########################################################################
## LIBRARIES
###########################################################################
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LIBS = 

###########################################################################
## SYSTEM LIBRARIES
###########################################################################

SYSTEM_LIBS = 

###########################################################################
## ADDITIONAL TOOLCHAIN FLAGS
###########################################################################

#---------------
# C Compiler
#---------------

CFLAGS_BASIC = $(DEFINES) @$(COMPILER_COMMAND_FILE)

CFLAGS = $(CFLAGS) $(CFLAGS_BASIC)

#-----------------
# C++ Compiler
#-----------------

CPPFLAGS_BASIC = $(DEFINES) @$(COMPILER_COMMAND_FILE)

CPPFLAGS = $(CPPFLAGS) $(CPPFLAGS_BASIC)

###########################################################################
## INLINED COMMANDS
###########################################################################

###########################################################################
## PHONY TARGETS
###########################################################################

.PHONY : all build buildobj clean info prebuild download execute set_environment_variables

all : build
    @cmd /C "@echo ### Successfully generated all binary outputs."

build : set_environment_variables prebuild $(PRODUCT)

buildobj : set_environment_variables prebuild $(OBJS) $(PREBUILT_OBJS)
    @cmd /C "@echo ### Successfully generated all binary outputs."

prebuild : 

download : $(PRODUCT)

execute : download
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    @cmd /C "@echo ### Invoking postbuild tool "Execute" ..."
    $(EXECUTE) $(EXECUTE_FLAGS)
    @cmd /C "@echo ### Done invoking postbuild tool."

set_environment_variables : 
    @set INCLUDE=$(INCLUDES);$(INCLUDE)
    @set LIB=$(LIB)

###########################################################################
## FINAL TARGET
###########################################################################

#-------------------------------------------
# Create a standalone executable            
#-------------------------------------------

$(PRODUCT) : $(OBJS) $(PREBUILT_OBJS) $(MAIN_OBJ)
    @cmd /C "@echo ### Creating standalone executable "$(PRODUCT)" ..."
    $(LD) $(LDFLAGS) -out:$(PRODUCT) @$(CMD_FILE) $(SYSTEM_LIBS) $(TOOLCHAIN_LIBS)
    @cmd /C "@echo ### Created: $(PRODUCT)"

###########################################################################
## INTERMEDIATE TARGETS
###########################################################################

#---------------------
# SOURCE-TO-OBJECT
#---------------------

.c.obj :
    $(CC) $(CFLAGS) -Fo"$@" "$<"

.cpp.obj :
    $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

{$(RELATIVE_PATH_TO_ANCHOR)}.c.obj :
    $(CC) $(CFLAGS) -Fo"$@" "$<"

{$(RELATIVE_PATH_TO_ANCHOR)}.cpp.obj :
    $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

{$(START_DIR)}.c.obj :
    $(CC) $(CFLAGS) -Fo"$@" "$<"

{$(START_DIR)}.cpp.obj :
    $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

{$(START_DIR)\rtwdemo_counter_ert_rtw}.c.obj :
    $(CC) $(CFLAGS) -Fo"$@" "$<"
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{$(START_DIR)\rtwdemo_counter_ert_rtw}.cpp.obj :
    $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

{$(MATLAB_ROOT)\rtw\c\src}.c.obj :
    $(CC) $(CFLAGS) -Fo"$@" "$<"

{$(MATLAB_ROOT)\rtw\c\src}.cpp.obj :
    $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

{$(MATLAB_ROOT)\simulink\src}.c.obj :
    $(CC) $(CFLAGS) -Fo"$@" "$<"

{$(MATLAB_ROOT)\simulink\src}.cpp.obj :
    $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

ert_main.obj : $(START_DIR)\rtwdemo_counter_ert_rtw\ert_main.c
    $(CC) $(CFLAGS) -Fo"$@" $(START_DIR)\rtwdemo_counter_ert_rtw\ert_main.c

rtwdemo_counter.obj : $(START_DIR)\rtwdemo_counter_ert_rtw\rtwdemo_counter.c
    $(CC) $(CFLAGS) -Fo"$@" $(START_DIR)\rtwdemo_counter_ert_rtw\rtwdemo_counter.c

###########################################################################
## DEPENDENCIES
###########################################################################

$(ALL_OBJS) : rtw_proj.tmw $(COMPILER_COMMAND_FILE) $(MAKEFILE)

###########################################################################
## MISCELLANEOUS TARGETS
###########################################################################

info : 
    @cmd /C "@echo ### PRODUCT = $(PRODUCT)"
    @cmd /C "@echo ### PRODUCT_TYPE = $(PRODUCT_TYPE)"
    @cmd /C "@echo ### BUILD_TYPE = $(BUILD_TYPE)"
    @cmd /C "@echo ### INCLUDES = $(INCLUDES)"
    @cmd /C "@echo ### DEFINES = $(DEFINES)"
    @cmd /C "@echo ### ALL_SRCS = $(ALL_SRCS)"
    @cmd /C "@echo ### ALL_OBJS = $(ALL_OBJS)"
    @cmd /C "@echo ### LIBS = $(LIBS)"
    @cmd /C "@echo ### MODELREF_LIBS = $(MODELREF_LIBS)"
    @cmd /C "@echo ### SYSTEM_LIBS = $(SYSTEM_LIBS)"
    @cmd /C "@echo ### TOOLCHAIN_LIBS = $(TOOLCHAIN_LIBS)"
    @cmd /C "@echo ### CFLAGS = $(CFLAGS)"
    @cmd /C "@echo ### LDFLAGS = $(LDFLAGS)"
    @cmd /C "@echo ### SHAREDLIB_LDFLAGS = $(SHAREDLIB_LDFLAGS)"
    @cmd /C "@echo ### CPPFLAGS = $(CPPFLAGS)"
    @cmd /C "@echo ### CPP_LDFLAGS = $(CPP_LDFLAGS)"
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    @cmd /C "@echo ### CPP_SHAREDLIB_LDFLAGS = $(CPP_SHAREDLIB_LDFLAGS)"
    @cmd /C "@echo ### ARFLAGS = $(ARFLAGS)"
    @cmd /C "@echo ### MEX_CFLAGS = $(MEX_CFLAGS)"
    @cmd /C "@echo ### MEX_CPPFLAGS = $(MEX_CPPFLAGS)"
    @cmd /C "@echo ### MEX_LDFLAGS = $(MEX_LDFLAGS)"
    @cmd /C "@echo ### MEX_CPPLDFLAGS = $(MEX_CPPLDFLAGS)"
    @cmd /C "@echo ### DOWNLOAD_FLAGS = $(DOWNLOAD_FLAGS)"
    @cmd /C "@echo ### EXECUTE_FLAGS = $(EXECUTE_FLAGS)"
    @cmd /C "@echo ### MAKE_FLAGS = $(MAKE_FLAGS)"

clean : 
    $(ECHO) "### Deleting all derived files..."
    @if exist $(PRODUCT) $(RM) $(PRODUCT)
    $(RM) $(ALL_OBJS)
    $(ECHO) "### Deleted all derived files."

If Intel compilers are installed, then when the build process is complete, you can run the executable
file.

if ispc
   system([model '.exe'])
else
   system(model)
end

Restore

You can optionally remove the folder you created earlier.

cd ..
rmdir('toolchain_demo', 's')

Reset the TargetRegistry to remove the toolchain that you registered above.

RTW.TargetRegistry.getInstance('reset');

Close the model.

close_system(model, 0)

Clear the variables introduced in the workspace.

clear INC K LIMIT RESET model tc cs toolchain
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Customize Build Process with STF_make_rtw_hook File
The build process lets you supply optional custom code in hook methods that are executed at
specified points in the code generation and make process. You can use hook methods to add target-
specific actions to the build process.

STF_make_rtw_hook File
You can modify hook methods in a file generically referred to as STF_make_rtw_hook.m, where STF
is the name of a system target file, such as ert or mytarget. This file implements a function,
STF_make_rtw_hook, that dispatches to a specific action, depending on the hookMethod argument
passed in.

The build process calls STF_make_rtw_hook, passing in the hookMethod argument and other
arguments. You implement only those hook methods that your build process requires.

If your model contains reference models, you can implement an STF_make_rtw_hook.m for each
reference model as required. The build process calls each STF_make_rtw_hook for reference
models, processing these files recursively (in dependency order).

Conventions for Using the STF_make_rtw_hook File
For the build process to call the STF_make_rtw_hook, check that the following conditions are met:

• The STF_make_rtw_hook.m file is on the MATLAB path.
• The file name is the name of your system target file (STF), appended to the text

_make_rtw_hook.m. For example, if you generate code with a custom system target file
mytarget.tlc, name your hook file mytarget_make_rtw_hook.m, and name the hook function
implemented within the file mytarget_make_rtw_hook.

• The hook function implemented in the file uses the function prototype described in
“STF_make_rtw_hook.m Function Prototype and Arguments” on page 85-36.

STF_make_rtw_hook.m Function Prototype and Arguments
The function prototype for STF_make_rtw_hook is:
function STF_make_rtw_hook(hookMethod, modelName, rtwRoot, templateMakefile,
buildOpts, buildArgs, buildInfo)

The arguments are defined as:

• hookMethod: Character vector specifying the stage of build process from which the
STF_make_rtw_hook function is called. The following flow chart summarizes the build process,
highlighting the hook points. Valid values for hookMethod are 'entry', 'before_tlc',
'after_tlc', 'before_make', 'after_make', 'exit', and 'error'. The
STF_make_rtw_hook function dispatches to the relevant code with a switch statement.
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• modelName: Character vector specifying the name of the model. Valid at all stages of the build
process.

• rtwRoot: Reserved.
• templateMakefile: Name of template makefile.
• buildOpts: A MATLAB structure that contains the Boolean field codeWasUpToDate. Valid for the

'before_make', 'after_make', and 'exit' stages only. The buildOpts fields include:
• buildArgs: Character vector containing the argument to make_rtw. When you invoke the build

process, buildArgs is copied from the argument following "make_rtw" in the Configuration
Parameters + Code Generation + Make command field.

For example, the following make arguments from the Make command field
make_rtw VAR1=0 VAR2=4

generate the following:
% make -f untitled.mk VAR1=0 VAR2=4
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The buildArgs argument does not apply for toolchain approach builds because these builds do
not allow adding make arguments to the make_rtw call. On the compiler command line, to
provide custom definitions (for example, VAR1=0 VAR2=4) that apply for both TMF approach and
toolchain approach builds, use the Configuration Parameters > Code Generation > Custom
Code > Defines field.

• buildInfo: The MATLAB structure that contains the model build information fields. Valid for the
'after_tlc', 'before_make', 'after_make', and 'exit' stages only. For information about
these fields and functions to access them, see “Build Process Customization”.

Applications for STF_make_rtw_hook.m
Here are some examples of how to apply the STF_make_rtw_hook.m hook methods.

In general, you can use the 'entry' hook to initialize the build process, for example, to change or
validate settings before code is generated. One application for the 'entry' hook is to rerun the auto-
configuration script that initially ran at target selection time to compare model parameters before
and after the script executes, for validation purposes.

The other hook points, 'before_tlc', 'after_tlc', 'before_make', 'after_make', 'exit',
and 'error' are useful for interfacing with external tool chains, source control tools, and other
environment tools.

For example, you could use the STF_make_rtw_hook.m file at a stage after 'entry' to obtain the
path to the build folder. At the 'exit' stage, you could then locate generated code files within the
build folder and check them into your version control system. You can use 'error' to clean up static
or global data used by the hook function when an error occurs during code generation or the build
process.

Note The build process temporarily changes the MATLAB working folder to the build folder for
stages 'before_make', 'after_make', 'exit', and 'error'. Your STF_make_rtw_hook.m file
must not make incorrect assumptions about the location of the build folder. At a point after the
'entry' stage, you can obtain the path to the build folder. In the following MATLAB code example,
the build folder path is returned as a character vector to the variable buildDirPath.
buildDirPath = rtwprivate('get_makertwsettings',gcs,'BuildDirectory');

Note A change to model configuration within STF_make_rtw_hook.m file (including switching
Variants) might lead to unexpected results in code generation.

Control Code Regeneration Using STF_make_rtw_hook.m
When you rebuild a model, by default, the build process performs checks to determine whether
changes to the model or relevant settings require regeneration of the top model code. (For details on
the criteria, see “Control Regeneration of Top Model Code” on page 57-34.) If the checks determine
that top model code generation is required, the build process fully regenerates and compiles the
model code. If the checks indicate that the top model generated code is current with respect to the
model, and model settings do not require full regeneration, the build process omits regeneration of
the top model code.

Regardless of whether the top model code is regenerated, the build process subsequently calls the
build process hooks, including STF_make_rtw_hook functions and the post code generation
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command. The following mechanisms allow you to perform actions related to code regeneration in the
STF_make_rtw_hook functions:

• To force code regeneration, use the following function call from the 'entry' hook:
rtw.targetNeedsCodeGen('set', true);

• In hooks from 'before_tlc' through 'exit', the buildOpts structure passed to the hook has
a Boolean field codeWasUpToDate. The field is set to true if model code was up to date and code
was not regenerated, or false if code was not up to date and code was regenerated. You can
customize hook actions based on the value of this field. For example:
...
case 'before_tlc'
    if buildOpts.codeWasUpToDate
        %Perform hook actions for up to date model
    else
        %Perform hook actions for full code generation
    end
...

Use STF_make_rtw_hook.m for Your Build Procedure
To create a custom STF_make_rtw_hook hook file for your build procedure, copy and edit the
example ert_make_rtw_hook.m file, which is located in the foldermatlabroot/toolbox/coder/
embeddedcoder (open), as follows:

1 Copy ert_make_rtw_hook.m to a folder in the MATLAB path. Rename it in accordance with the
naming conventions described in “Conventions for Using the STF_make_rtw_hook File” on page
85-36. For example, to use it with the GRT target grt.tlc, rename it to
grt_make_rtw_hook.m.

2 Rename the ert_make_rtw_hook function within the file to match the file name.
3 Implement the hooks that you require by adding code to case statements within the switch

hookMethod statement.

Hook Method after_tlc
The after_tlc hook method is available solely for backwards compatibility.

The format of the generated code during the after_tlc stage is not the final format.

See Also

Related Examples
• “Customize Build Process with sl_customization.m” on page 85-40
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Customize Build Process with sl_customization.m
The Simulink customization file sl_customization.m is a mechanism that allows you to use
MATLAB to customize the build process interface. The Simulink software reads the
sl_customization.m file, if present on the MATLAB path, when it starts and the customizations
specified in the file are applied to the Simulink session. For more information on the
sl_customization.m customization file, see “Registering Customizations”.

The sl_customization.m File
The sl_customization.m file can be used to register installation-specific hook functions to be
invoked during the build process. The hook functions that you register through
sl_customization.m complement System Target File (STF) hooks (described in “Customize Build
Process with STF_make_rtw_hook File” on page 85-36) and post-code generation commands
(described in “Customize Post-Code-Generation Build Processing” on page 85-8).

The following figure shows the relationship between installation-level hooks and the other available
mechanisms for customizing the build process.
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Register Build Process Hook Functions Using sl_customization.m
To register installation-level hook functions that are invoked during the build process, you create a
MATLAB function called sl_customization.m and include it on the MATLAB path of the Simulink
installation that you want to customize. The sl_customization function accepts one argument: a
handle to a customization manager object. For example,

function sl_customization(cm)

As a starting point for your customizations, the sl_customization function must first get the
default (factory) customizations, using the following assignment statement:

hObj = cm.RTWBuildCustomizer;

You then invoke methods to register your customizations. The customization manager object includes
the following method for registering build process hook customizations:
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• addUserHook(hObj, hookType, hook)

Registers the MATLAB hook script or function specified by hook for the build process stage
represented by hookType. The valid values for hookType are 'entry', 'before_tlc',
'after_tlc', 'before_make', 'after_make', and 'exit'.

Use this method to register installation-specific hook functions in your instance of the
sl_customization function.

The Simulink software reads the sl_customization.m file when it starts. If you subsequently
change the file, you must restart the Simulink session or enter the following command in the
Command Window to enable the changes:
sl_refresh_customizations

Variables Available for sl_customization.m Hook Functions
The following variables are available for sl_customization.m hook functions to use:

• modelName — The name of the Simulink model (valid for all stages)
• dependencyObject — An object containing the dependencies of the generated code (valid only

for the 'after_make' stage)

A hook script can directly access the valid variables. A hook function can pass the valid variables as
arguments to the function. For example:
hObj.addUserHook('after_make', 'afterMakeFunction(modelName,dependencyObject);');

Example of Build Process Customization with sl_customization.m
The sl_customization.m file shown in the example, sl_customization.m for Build Process
Customizations, uses the addUserHook method to specify installation-specific build process hooks
to be invoked at the 'entry' and 'after_tlc' stages of the build process. For the hook function
source code, see the CustomRTWEntryHook.m and CustomRTWPostProcessHook.m examples.

Example 85.1. sl_customization.m for Build Process Customizations
function sl_customization(cm)
% Register user customizations

% Get default (factory) customizations
hObj = cm.RTWBuildCustomizer;

% Register build process hooks
hObj.addUserHook('entry', 'CustomRTWEntryHook(modelName);');
hObj.addUserHook('after_tlc', 'CustomRTWPostProcessHook(modelName);');

end

Example 85.2. CustomRTWEntryHook.m
function [str, status] = CustomRTWEntryHook(modelName)
str =sprintf('Custom entry hook for model ''%s.''',modelName);
disp(str)
status =1;

Example 85.3. CustomRTWPostProcessHook.m
function [str, status] = CustomRTWPostProcessHook(modelName)
str =sprintf('Custom post process hook for model ''%s.''',modelName);
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disp(str)
status =1;

If you include the above three files on the MATLAB path of the Simulink installation that you want to
customize, the coded hook function messages appear in the displayed output for builds. For example,
if you open the ERT-based model rtwdemo_udt, open the Code Generation pane of the
Configuration Parameters dialog box, and press Ctrl+B to initiate a build, the following messages are
displayed:
>> rtwdemo_udt

### Starting build procedure for model: rtwdemo_udt
Custom entry hook for model 'rtwdemo_udt.'
Custom post process hook for model 'rtwdemo_udt.'
### Successful completion of build procedure for model: rtwdemo_udt
>> 

See Also

Related Examples
• “Use STF_make_rtw_hook.m for Your Build Procedure” on page 85-39
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Replace STF_rtw_info_hook Supplied Target Data
Prior to MATLAB Release 14, custom targets supplied target-specific information with a hook file
(referred to as STF_rtw_info_hook.m). The STF_rtw_info_hook specified properties such as
word sizes for integer data types (for example, char, short, int, and long), and C implementation-
specific properties of the custom target.

The STF_rtw_info_hook mechanism has been replaced by the Hardware Implementation pane of
the Configuration Parameters dialog box. Using this dialog box, you can specify properties that were
formerly specified in your STF_rtw_info_hook file.

For backward compatibility, existing STF_rtw_info_hook files are available. However, you should
convert your target and models to use of the Hardware Implementation pane. See “Configure
Production and Test Hardware”.
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Custom Target Development in Simulink
Coder

• “Custom Targets” on page 86-2
• “Sample Custom Targets” on page 86-3
• “Target Development Folders, Files, and Builds” on page 86-5
• “Customize System Target Files” on page 86-18
• “Customize Template Makefiles” on page 86-43
• “Custom Target Optional Features” on page 86-56
• “Support Toolchain Approach with Custom Target” on page 86-58
• “Support Model Referencing” on page 86-60
• “Support Compiler Optimization Level Control” on page 86-65
• “Support C Function Prototype Control” on page 86-67
• “Support C++ Class Interface Control” on page 86-69
• “Support Concurrent Execution of Multiple Tasks” on page 86-71
• “Device Drivers” on page 86-72
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Custom Targets
A custom target is a software package that you create to deploy MATLAB and Simulink designs to
target hardware. Using the package, you can perform tasks to optimize, prototype, verify, and deploy
an application to your hardware. This table lists tasks that you can perform.

Task See
Generate code for a specific processor. “Customize System Target Files” on page 86-18

“Run-Time Environment Configuration”
Optimize generated code by using a processor-
specific code-replacement library.

“Code Replacement”

Integrate real-time operating systems and device
drivers.

“Device Drivers” on page 86-72

Build, deploy, download, and run the application
on target hardware.

“Build Process”

Tune parameters and monitor target application
signals during an external mode simulation.

“External Mode Simulation by Using XCP
Communication” on page 58-7

“Customize XCP Slave Software” on page 58-35
Perform code execution profiling through a
processor-in-the-loop (PIL) simulation.

“Code Execution Profiling with SIL and PIL” on
page 74-2

“Set Up PIL Connectivity by Using target
Package” on page 80-49

Test numerical equivalence between your
MATLAB code or Simulink model and the
generated code by running a PIL simulation.

“Set Up PIL Connectivity by Using target
Package” on page 80-49

“Configure and Run PIL Simulation” on page 80-
26

You can also create custom targets that are based on MathWorks reference targets. For example, see:

• “Embedded Coder Support Package for ARM Cortex-A Processors”
• “Embedded Coder Support Package for ARM Cortex-M Processors”

See Also

More About
• “Customize System Target Files”
• “Support C Function Prototype Control”
• “Support C++ Class Interface Control”
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Sample Custom Targets
There are technical solutions on the MathWorks Web site that you can use as a starting point to
create your own target solution. The solutions provide guides to the following tasks for creating
custom targets:

• Methods of embedding code onto a custom processor
• Creating a system target file
• Customizing the makefile and main file
• Adding compiler, chip, and board specific information
• Integrating legacy code and device drivers
• Creating blocks and libraries
• Implementing processor-in-the-loop (PIL) testing.

Consider these options:

• Download the embedded targets development guide zip file from this web page:

Is there an example guide on developing an embedded target...?

The zip file provides example files and a guide to developing a custom embedded target. The
guide is divided into two parts, one on creating a generic custom target and another on creating a
target for the Freescale™ S12X processor using the Cosmic Compiler.

Read the example guide along with this document to understand the tasks for developing
embedded targets.

• For more detailed example files for specific processors, see:

• Is there an example Freescale S12X target... using the Cosmic Compiler?
• Is there an example Freescale S12X target... using the CodeWarrior Compiler?

These example kits contain example models, code generation files, and instruction guides on
generating and testing code for the processor. The Cosmic example illustrates the use of the
target connectivity API for processor-in-the-loop (PIL) testing. The CodeWarrior example does not
have PIL but shows CAN Calibration Protocol (CCP) and Simulink external mode.

The intent of the example kits is to provide working examples that you can use as a base to create
your own target solution. The intent is not to provide a full featured and maintained Embedded
Target product like those provided by MathWorks or third-party products, as listed on the
Embedded Coder Hardware Support Web page.

• You can watch a video that shows an overview of the example kit www.mathworks.com/videos/
programming-the-freescale-s12x-target-68811.html.

• For an example target for the ARM9 (STR9) processor, see Is there an example ARM9 (STR9)
target... using the GNU ARM Compiler and Hitex STR9-comStick?.

If you have questions on specific targets, email mytarget@mathworks.com.

The example kits and this document describe Embedded Coder features such as customized ert
system target files and processor-in-the-loop testing, but you can study the examples as a starting
point for use with Simulink Coder targets.
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See Also

More About
• “Custom Targets”
• “Customize System Target Files”
• “Customize Template Makefiles”
• “Custom Target Optional Features”
• “Support Toolchain Approach with Custom Target”
• “Device Drivers”
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Target Development Folders, Files, and Builds
Target development mechanics work with a number of folder and file types. The following topics
provide the information to develop custom targets, configure folder usage, and use custom targets in
the build process.

Folder and File Naming Conventions
You can use a single folder for your custom target files, or if desired you can use subfolders, for
example containing files associated with specific development environments or tools.

For a custom target implementation, the recommended folder and file naming conventions are

• Use only lowercase in folder names, filenames, and extensions.
• Do not embed spaces in folder names. Spaces in folder names cause errors with many third-party

development environments.
• Include desired folders in the MATLAB path
• Do not place your custom target folder anywhere in the MATLAB folder tree (that is, in or under

the matlabroot folder). If you place your folder under matlabroot you risk losing your work if
you install a new MATLAB version (or reinstall the current version).

The following sections explain how to organize your target folders and files and add them to your
MATLAB path. They also provide high-level descriptions of the files.

In this document, mytarget is a placeholder name that represents folders and files that use the
target's name. The names dev_tool1, dev_tool2, and so on represent subfolders containing files
associated with development environments or tools. This document describes an example structure
where the folder mytarget contains subfolders for mytarget, blocks, dev_tool1, dev_tool2.
The top level folder mytarget is the target root folder.

Components of a Custom Target
• “Overview” on page 86-5
• “Code Components” on page 86-6
• “Control Files” on page 86-7

Overview

The components of a custom target are files located in a hierarchy of folders. The top-level folder in
this structure is called the target root folder. The target root folder and its contents are named,
organized, and located on the MATLAB path according to conventions described in “Folder and File
Naming Conventions” on page 86-5.

The components of a custom target include

• Code components: C source code that supervises and supports execution of generated model
code.

• Control files:

• A system target file to control the code generation process.
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• File(s) to control the building of an executable from the generated code. In a traditional make-
based environment, a template makefile (TMF) generates a makefile for this purpose. Another
approach is to generate project files in support of a modern integrated development
environment (IDE) such as the Freescale Semiconductor CodeWarrior IDE.

• Hook files: Optional TLC and MATLAB program files that can be invoked at well-defined stages
of the build process. Hook files let you customize the build process and communicate
information between various phases of the process.

• Other target files: Files that let you integrate your target into the MATLAB environment. For
example, you can provide an info.xml file to make your target block libraries and examples
available from a MATLAB session.

The next sections introduce key concepts and terminology you need to know to develop each
component. References to more detailed information sources are provided.

Code Components

An executable program containing code generated from a Simulink model consists of a number of
code modules and data structures. These fall into two categories: application components and
execution support files.

Application Components

Application components are those which are specific to a particular model; they implement the
functions represented by the blocks in the model. Application components are not specific to the
target. Application components include

• Modules generated from the model
• User-written blocks (S-functions)
• Parameters of the model that are visible, and can be interfaced to, external code

Execution Support Files

A number of code modules and data structures, referred to collectively as the execution support files,
are responsible for managing and supporting the execution of the generated program. The execution
support files modules are not automatically generated. Depending on the requirements of your target,
you must implement certain parts of the execution support files. Execution Support Files summarizes
the execution support files.

Execution Support Files

You Provide... The Code Generator Provides...
Customized main program Generic main program
Timer interrupt handler to run model Execution engine and integration solver (called by

timer interrupt handler)
Other interrupt handlers Example interrupt handlers (Asynchronous Interrupt

blocks)
Device drivers Example device drivers
Data logging, parameter tuning, signal
monitoring, and external mode support

Data logging, parameter tuning, signal monitoring, and
external mode APIs
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User-Written Execution Support Files

The code generator provides most of the execution support files. Depending on the requirements of
your target, you must implement some or all of the following elements:

• A timer interrupt service routine (ISR). The timer runs at the program's base sample rate. The
timer ISR is responsible for operations that must be completed within a single clock period, such
as computing the current output sample. The timer ISR usually calls the rt_OneStep function.

If you are targeting a real-time operating system (RTOS), your generated code usually executes
under control of the timing and task management mechanisms provided by the RTOS. In this case,
you may not have to implement a timer ISR.

• The main program. Your main program initializes the blocks in the model, installs the timer ISR,
and executes a background task or loop. The timer periodically interrupts the main loop. If the
main program is designed to run for a finite amount of time, it is also responsible for cleanup
operations — such as memory deallocation and masking the timer interrupt — before terminating
the program.

If you are targeting a real-time operating system (RTOS), your main program most likely spawns
tasks (corresponding to the sample rates used in the model) whose execution is timed and
controlled by the RTOS.

Your main program typically is based on a generated or static main program. For details on the
structure of the execution support files, code execution, and guidelines for customizing main
programs, see “Deploy Generated Standalone Executable Programs To Target Hardware” on page
66-2.

• Device drivers. Drivers communicate with I/O devices on your target hardware. In production
code, device drivers are normally implemented as inlined S-functions.

• Other interrupt handlers. If your models need to support asynchronous events, such as hardware
generated interrupts and asynchronous read and write operations, you must supply interrupt
handlers. The Interrupt Templates library provides examples.

• Data logging, parameter tuning, signal monitoring, and external mode support. It is atypical to
implement rapid prototyping features such as external mode support in an embedded target.
However, it is possible to support these features by using standard code generator APIs. See
“Calibration and Measurement” for details.

Control Files

The code generation and build process is directed by a number of TLC and MATLAB files collectively
called control files. This section introduces and summarizes the main control files.
Top-Level Control File (make_rtw)

The build process is initiated when you press Ctrl+B. At this point, the build process parses the
Make command field of the Code Generation pane of the Configuration Parameters dialog box,
expecting to find the name of a MATLAB command that controls the build process (as well as optional
arguments to that command). The default command is make_rtw, and the default top-level control
file for the build process is make_rtw.m.

Note make_rtw is an internal MATLAB command used by the build process. Normally, target
developers do not need detailed knowledge of how make_rtw works. (The details for target
developers are described in “Target Development and the Build Process” on page 86-13.) You should
not invoke make_rtw directly from MATLAB code, and you should not customize make_rtw.m.
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The make_rtw.m file contains the logic required to execute your target-specific control files,
including a number of hook points for execution of your custom code. make_rtw does the following:

• Passes optional arguments in to the build process
• Performs required preprocessing before code generation
• Executes the system target file to perform code generation (and optional HTML report generation)
• Processes the TMF to generate a makefile
• Invokes a make utility to execute the makefile and build an executable
• Performs required post-processing (such as generating calibration data files or downloading the

generated executable to the target)

System Target File

The Target Language Compiler (TLC) generates target-specific C or C++ code from a partial
description of your Simulink block diagram (model.rtw). The Target Language Compiler reads
model.rtw and executes a program consisting of several target files (.tlc files.) The system target
file, at the top level of this program, controls the code generation process. The output of this process
is a number of source files, which are fed to your development system's make utility.

You need to create a customized system target file to set code generation parameters for your target.
You should copy, rename, and modify the standard ERT system target file (matlabroot/rtw/c/ert/
ert.tlc).

The detailed structure of the system target file is described in “Customize System Target Files” on
page 86-18.

Note The system target file selects whether the target supports the toolchain approach or template
makefile approach for code generation. See “Customize System Target Files” on page 86-18.

Template Makefile (TMF)

A TMF provides information about your model and your development system. The build process uses
this information to create a makefile (.mk file) that builds an executable program.

Some targets implement more than one TMF, in order to support multiple development environments
(for example, two or more cross-compilers) or multiple modes of code generation (for example,
generating a binary executable versus generating a project file for your compiler).

The Embedded Coder software provides a large number of TMFs suitable for different types of
development computer systems. These TMFs are located in matlabroot/toolbox/coder/
compile/tmf. The standard TMFs are described in “Template Makefiles and Make Options”.

The detailed structure of the TMF is described in “Customize Template Makefiles” on page 86-43.

Note The system target file selects whether the target supports the toolchain approach or template
makefile approach for code generation. See “Customize System Target Files” on page 86-18.
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Hook Files

The build process allows you to supply optional hook files that are executed at specified points in the
code generation and make process. You can use hook files to add target-specific actions to the build
process.

The hook files must follow well-defined naming and location requirements. “Folder and File Naming
Conventions” on page 86-5 describes these requirements.

Key Folders Under Target Root (mytarget)
• “Target Root Folder (mytarget)” on page 86-9
• “Target Folder (mytarget/mytarget)” on page 86-9
• “Target Block Folder (mytarget/blocks)” on page 86-9
• “Development Tools Folder (mytarget/dev_tool1, mytarget/dev_tool2)” on page 86-10
• “Target Source Code Folder (mytarget/src)” on page 86-10

Target Root Folder (mytarget)

This folder contains the key subfolders for the target (see “Folder and File Naming Conventions” on
page 86-5). You can also locate miscellaneous files (such as a readme file) in the target root folder.
The following sections describe required and optional subfolders and their contents.

Target Folder (mytarget/mytarget)

This folder contains files that are central to the target, such as the system target file (STF) and
template makefile (TMF). “Key Files in Target Folder (mytarget/mytarget)” on page 86-11
summarizes the files that should be stored in mytarget/mytarget, and provides pointers to detailed
information about these files.

Note mytarget/mytarget should be on the MATLAB path.

Target Block Folder (mytarget/blocks)

If your target includes device drivers or other blocks, locate the block implementation files in this
folder. mytarget/blocks contains

• Compiled block MEX-files
• Source code for the blocks
• TLC inlining files for the blocks
• Library models for the blocks (if you provide your blocks in one or more libraries)

Note mytarget/blocks should be on the MATLAB path.

You can also store example models and supporting files in mytarget/blocks. Alternatively, you can
create a mytarget/mytargetdemos folder, which should also be on the MATLAB path.
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To display your blocks in the standard Simulink Library Browser and/or integrate your example
models into the MATLAB session environment , you can create the files described below and store
them in mytarget/blocks.

mytarget/blocks/slblocks.m

This file allows a group of blocks to be integrated into the Simulink Library and Simulink Library
Browser.

Example 86.1. Example slblocks.m File
function blkStruct = slblocks
% Information for "Blocksets and Toolboxes" subsystem
blkStruct.Name = sprintf('Embedded Target\n for MYTARGET');
blkStruct.OpenFcn = 'mytargetlib';
blkStruct.MaskDisplay = 'disp(''MYTARGET'')';

% Information for Simulink Library Browser
Browser(1).Library = 'mytargetlib';
Browser(1).Name    = 'Embedded Target for MYTARGET';
Browser(1).IsFlat  = 1;% Is this library "flat" (i.e. no subsystems)?

blkStruct.Browser = Browser;

mytarget/blocks/demos.xml

This file provides information about the components, organization, and location of example models.
MATLAB software uses this information to place the example in the MATLAB session environment.

Example 86.2. Example demos.xml File
<?xml version="1.0" encoding="utf-8"?>
<demos>
   <name>Embedded Target for MYTARGET</name>
   <type>simulink</type>
   <icon>$toolbox/matlab/icons/boardicon.gif</icon>
   <description source = "file">mytarget_overview.html</description>

   <demosection>
      <label>Multirate model</label>
      <demoitem>
         <label>MYTARGET demo</label>
         <file>mytarget_overview.html</file>
         <callback>mytarget_model</callback>
      </demoitem>
   </demosection>

</demos>

Development Tools Folder (mytarget/dev_tool1, mytarget/dev_tool2)

These folders contain files associated with specific development environments or tools (dev_tool1,
dev_tool2, etc.). Normally, your target supports at least one such development environment and
invokes its compiler, linker, and other utilities during the build process. mytarget/dev_tool1
includes linker command files, startup code, hook functions, and other files required to support this
process.

For each development environment, you should provide a separate folder.

Target Source Code Folder (mytarget/src)

This folder is optional. If the complexity of your target requires it, you can use mytarget/src to
store common source code and configuration code (such as boot and startup code).
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Key Files in Target Folder (mytarget/mytarget)
• “Introduction” on page 86-11
• “mytarget.tlc” on page 86-11
• “mytarget.tmf” on page 86-11
• “mytarget_genfiles.tlc” on page 86-11
• “mytarget_main.c” on page 86-12
• “STF_make_rtw_hook.m” on page 86-12
• “STF_rtw_info_hook.m (obsolete)” on page 86-12
• “info.xml” on page 86-12
• “mytarget_overview.html” on page 86-12

Introduction

The target folder mytarget/mytarget contains key files in your target implementation. These
include the system target file, template makefile, main program module, and optional M and TLC
hook files that let you add target-specific actions to the build process. The following sections describe
the key target folder files.

mytarget.tlc

mytarget.tlc is the system target file. Functions of the system target file include

• Making the target visible in the System Target File Browser
• Definition of code generation options for the target (inherited and target-specific)
• Providing an entry point for the top-level control of the TLC code generation process

You should base your system target file on ert.tlc, the system target file provided by Embedded
Coder software.

“Customize System Target Files” on page 86-18 gives detailed information on the structure of the
system target file, and also gives instructions on how to customize a system target file to

• Display your target in the System Target File Browser
• Add your own target options to the Configuration Parameters dialog box
• Tailor the code generation and build process to the requirements of your target

mytarget.tmf

mytarget.tmf is the template makefile for building an executable for your target.

For basic information on the structure and operation of template makefiles, see “Customize Template
Makefiles” on page 86-43.

mytarget_genfiles.tlc

This file is optional. mytarget_genfiles.tlc is useful as a central file from which to invoke target-
specific TLC files that generate additional files as part of your target build process. For example, your
target may create sub-makefiles or project files for a development environment, or command scripts
for a debugger to do automatic downloads. See “Using mytarget_genfiles.tlc” on page 86-30 for
details.
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mytarget_main.c

A main program module is required for your target. To provide a main module, you can either

• Modify the rt_main.c or rt_cppclass_main.cpp module provided by the software
• Generate mytarget_main.c or .cpp during the build process

For a description of the operation of main programs, see “Deploy Generated Standalone Executable
Programs To Target Hardware” on page 66-2. The section also contains guidelines for generating and
modifying a main program module.

STF_make_rtw_hook.m

STF_make_rtw_hook.m is an optional hook file that you can use to invoke target-specific functions
or executables at specified points in the build process. STF_make_rtw_hook.m implements a
function that dispatches to a specific action depending on the method argument that is passed into it.

“Customize Build Process with STF_make_rtw_hook File” describes the operation of the
STF_make_rtw_hook.m hook file in detail.

STF_rtw_info_hook.m (obsolete)

Prior to Release 14, custom targets supplied target-specific information with a hook file (referred to
as STF_rtw_info_hook.m). The STF_rtw_info_hook specified properties such as word sizes for
integer data types (for example, char, short, int, and long), and C implementation-specific
properties of the custom target.

The STF_rtw_info_hook mechanism has been replaced by the Hardware Implementation pane of
the Configuration Parameters dialog box. Using this dialog box, you can specify the properties that
were formerly specified in your STF_rtw_info_hook file.

For backward compatibility, existing STF_rtw_info_hook files are still available. However, you
should convert your target and models to use the Hardware Implementation pane. See “Configure
Run-Time Environment Options”.

info.xml

This file provides information to MATLAB software that specifies where to display the target toolbox
in the MATLAB session environment. For more information, see “Display Custom Documentation”.

mytarget_overview.html

By convention, this file serves as home page for the target examples.

The <description> field in demos.xml should point to mytarget_overview.html (see
“mytarget/blocks/demos.xml” on page 86-10).

Example mytarget_overview.html File
<html>
<head><title>Embedded Target for MYTARGET</title></head><body>
<p style="color:#990000; font-weight:bold; font-size:x-large">Embedded Target
for MYTARGET Example Model</p>

<p>This example provides a simple model that allows you to generate an executable
for a supported target board. You can then download and run the executable and
set breakpoints to study and monitor the execution behavior.</p>
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</body>
</html>

Additional Files for Externally Developed Targets
• “Introduction” on page 86-13
• “mytarget/mytarget/mytarget_setup.m” on page 86-13
• “mytarget/mytarget/doc” on page 86-13

Introduction

If you are developing an embedded target that is not installed into the MATLAB tree, you should
provide a target setup script and target documentation within mytarget/mytarget, for the
convenience of your users. The following sections describe the required materials and where to place
them.

mytarget/mytarget/mytarget_setup.m

This file script adds paths for your target to the MATLAB path. Your documentation should instruct
users to run the script when installing the target.

You should include a call to the MATLAB function savepath in your mytarget_setup.m script. This
function saves the added paths, so users need to run mytarget_setup.m only once.

The following code is an example mytarget_setup.m file.

function mytarget_setup()
curpath = pwd;
tgtpath = curpath(1:end-length('\mytarget'));
addpath(fullfile(tgtpath, 'mytarget'));
addpath(fullfile(tgtpath, 'dev_tool1'));
addpath(fullfile(tgtpath, 'blocks'));
addpath(fullfile(tgtpath, 'mytargetdemos'));
savepath;
disp('MYTARGET Target Path Setup Complete.');

mytarget/mytarget/doc

You should put the documentation related to your target in the folder mytarget/mytarget/doc.

Target Development and the Build Process
• “About the Build Process” on page 86-13
• “Build Process Phases and Information Passing” on page 86-14
• “Additional Information Passing Techniques” on page 86-15

About the Build Process

To develop an embedded target, you need a thorough understanding of the build process. Your
embedded target uses the build process and may require you to modify or customize the process. A
general overview of code generation and the build process is given in “Code Generation” and “Build
Process”.
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This section supplements that overview with a description of the build process as customized by the
Embedded Coder software. The emphasis is on points in the process where customization hooks are
available and on passing information between different phases of the process.

This section concludes with “Additional Information Passing Techniques” on page 86-15, describing
assorted tips and tricks for passing information during the build process.

Build Process Phases and Information Passing

It is important to understand where (and when) the build process obtains required information.
Sources of information include

• The model.rtw file, which provides information about the generating model. The information in
model.rtw is available to target TLC files.

• The code generation panes of the Configuration Parameters dialog box. Options (both general and
target-specific) are provided through check boxes, menus, and edit fields. You can associate
options with TLC variables in the rtwoptions data structure. Use the Configuration
Parameters > Code Generation > Custom Code > Additional build information > Defines
field to define makefile tokens .

• The selected toolchain (for toolchain approach builds) or selected template makefile .tmf (for
template makefile approach builds); these generate the model-specific makefile.

• Environment variables on the host computer. Environment variables provide additional
information about installed development tools.

• Other target-specific files such as target-related TLC files, linker command files, or project files.

It is also important to understand the several phases of the build process and how to pass information
between the phases. The build process comprises several high-level phases:

• Execution of the top-level file (slbuild.m) to sequence through the build process for a target
• Conversion of the model into the TLC input file (model.rtw)
• Generation of the target code by the TLC compiler
• Compilation of the generated code with make or other utilities
• Transmission of the final generated executable to the target hardware with a debugger or

download utility

It is helpful to think of each phase of the process as a different “environment” that maintains its own
data. These environments include

• MATLAB code execution environment (MATLAB)
• Simulink
• Target Language Compiler execution environment
• makefile
• Development environments such as and IDE or debugger

In each environment, you might get information from the various sources mentioned above. For
example, during the TLC phase, execute MATLAB file might execute to obtain information from the
MATLAB environment. Also, a given phase may generate information for a subsequent phase.

See “Key Files in Target Folder (mytarget/mytarget)” on page 86-11 for details on the available
MATLAB file and TLC hooks for information passing, with code examples.
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Additional Information Passing Techniques

This section describes a number of useful techniques for passing information among different phases
of the build process.

tlcvariable Field in rtwoptions Structure

Parameters on the code generation panes of the Configuration Parameters dialog box can be
associated with a TLC variable, and specified in the tlcvariable field of the option's entry in the
rtwoptions structure. The variable value is passed on the command line when TLC is invoked. This
provides a way to make code generation parameters and their values available in the TLC phase.

See “System Target File Structure” on page 86-18 for further information.

makevariable Field in rtwoptions Structure

You can associate code generation parameters with a template makefile token, that you specify in the
makevariable field of the option's entry in the rtwoptions structure. If a token of the same name
as the makevariable name exists in the TMF, the token is updated with the option value when the
final makefile is created. If the token does not exist in the TMF, the makevariable is passed in on
the command line when make is invoked. Thus, in either case, the makevariable is available to the
makefile.

See “System Target File Structure” on page 86-18 for further information.

Accessing Host Environment Variables

You can access host shell environment variables at the MATLAB command line by entering the
getenv command. For example:

getenv ('MSDEVDIR')

ans =

D:\Applications\Microsoft Visual Studio\Common\MSDev98

To access the same information from TLC, use the FEVAL directive to invoke getenv.

%assign eVar = FEVAL("getenv","<varname>")

Supplying Development Environment Information to Your Template Makefile

An embedded target must tie the build process to target-specific development tools installed on a
host computer. For the make process to run these tools, the TMF must be able to determine the name
of the tools, the path to the compiler, linker, and other utilities, and possibly the host operating
system environment variable settings.

Require the end user to modify the target TMF. The user enters path information (such as the location
of a compiler executable), and possibly host operating system environment variables, as make
variables. This allows the TMF to be tailored to specific needs.

Using MATLAB Application Data

Application data provides a way for applications to save and retrieve data stored with the GUI. This
technique enables you to create what is essentially a user-defined property for an object, and use this
property to store data for use in the build process. If you are unfamiliar with this technique for
creating graphical user interfaces, see “Store Data as Application Data”.
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The following code examples illustrates the use of application data to pass information to TLC.

This file, tlc2appdata.m, stores the data passed in as application data under the name passed in
(appDataName).

function k = tlc2appdata(appDataName,data)
  disp([mfilename,': ',appDataName,' ', data]);
  setappdata(0,appDataName,data);
  k = 0;  % TLC expects a return value for FEVAL.

The following sample TLC file uses the FEVAL directive to invoke tlc2appdata.m to store arbitrary
application data, under the name z80.

%% test.tlc
%%
%assign myApp = "z80"
%assign myData = "314159"
%assign dummy = FEVAL("tlc2appdata",myApp,myData)

To test this technique:

1 Create the tlc2appdata.m file as shown. Check that tlc2appdata.m is stored in a folder on
the MATLAB path.

2 Create the TLC file as shown. Save it as test.tlc.
3 Enter the following command at the MATLAB prompt to execute the TLC file:

tlc test.tlc
4 Get the application data at the MATLAB prompt:

k = getappdata(0,'z80')

The function returns the value 314159.
5 Enter the following command.

who

Note that application data is not stored in the MATLAB workspace. Also observe that the z80
data is not visible. Using application data in this way has the advantage that it does not clutter
the MATLAB workspace. Also, it helps prevent you from accidentally deleting your data, since it
is not stored directly in your workspace.

A real-world use of application data might be to collect information from the model.rtw file and
store it for use later in the build process.

Adding Block-Specific Information to the Makefile

The rtwmakecfg mechanism provides a method for inlined S-functions such as driver blocks to add
information to the makefile. This mechanism is described in “Use rtwmakecfg.m API to Customize
Generated Makefiles”.
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See Also

More About
• “Custom Targets”
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Customize System Target Files
This section provides information on the structure of the system target file, guidelines for
customizing a system target file, and a basic tutorial that helps you to produce a skeletal system
target file.

Control Code Generation With the System Target File
The system target file controls the code generation stage of the build process. The system target file
also lets you control the presentation of your target to the end user. The system target file provides

• Definitions of variables that are fundamental to the build process, such as the value for the
CodeFormat TLC variable

• The main entry point to the top-level TLC program that generates code
• Target information for display in the System Target File Browser
• A mechanism for defining target-specific code generation options (and other parameters related to

the build process) and for displaying them in the Configuration Parameters dialog box
• A mechanism for inheriting options from another target (such as the Embedded Real-Time (ERT)

target)

Note that, although the system target file is a Target Language Compiler (TLC) file, it contains
embedded MATLAB code. Before creating or modifying a system target file, you should acquire a
working knowledge of TLC and of the MATLAB language. “Target Language Compiler” and “Scripts
vs. Functions” describe the features and syntax of both the TLC and MATLAB languages.

While reading this section, you may want to refer to the system target files provided with the code
generator. Most of these files are stored in the target-specific folders under matlabroot/rtw/c
(open). Additional system target files are stored under matlabroot/toolbox/rtw/targets (open).

System Target File Naming and Location Conventions
A system target file must be located in a folder on the MATLAB path for the target to be displayed in
the System Target File Browser and invoked in the build process. Follow the location and naming
conventions for system target files and related target files given in “Folder and File Naming
Conventions” on page 86-5.

System Target File Structure
• “Overview” on page 86-19
• “Header Comments” on page 86-20
• “TLC Configuration Variables” on page 86-21
• “TLC Program Entry Point and Related %includes” on page 86-21
• “RTW_OPTIONS Section” on page 86-22
• “rtwgensettings Structure” on page 86-22
• “Additional Code Generation Options” on page 86-24
• “Model Reference Considerations” on page 86-24
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Overview

This section is a guide to the structure and contents of a system target file. The following listing
shows the general structure of a system target file. Note that this is not a complete code listing of a
system target file. The listing consists of excerpts from each of the sections that make up a system
target file.

%%----------------------------
%% Header Comments Section
%%----------------------------
%% SYSTLC: Example Real-Time Target
%%    TMF: my_target.tmf MAKE: make_rtw
%% Initial comments contain directives for STF Browser.
%% Documentation, date, copyright, and other info may follow.
          ...
%selectfile NULL_FILE
         ...
%%----------------------------
%% TLC Configuration Variables Section
%%----------------------------
%% Assign code format, language, target type.
%%
%assign CodeFormat = "Embedded-C"
%assign TargetType = "RT"
%assign Language   = "C"
%%
%%----------------------------
%% TLC Program Entry Point
%%----------------------------
%% Call entry point function.
%include "codegenentry.tlc"
%%
%%----------------------------
%% (OPTIONAL) Generate Files for Build Process
%%----------------------------
%include "mytarget_genfiles.tlc"
%%----------------------------
%% RTW_OPTIONS Section
%%----------------------------
/%
  BEGIN_RTW_OPTIONS
  %% Define rtwoptions structure array. This array defines target-specific
  %% code generation variables, and controls how they are displayed.
  rtwoptions(1).prompt = 'example code generation options';
        ...
  rtwoptions(6).prompt = 'Show eliminated blocks';
  rtwoptions(6).type = 'Checkbox';
         ...
  %----------------------------------------%
  % Configure RTW code generation settings %
  %----------------------------------------%
         ...
  %%----------------------------
  %% rtwgensettings Structure
  %%----------------------------
  %% Define suffix text for naming build folder here.
  rtwgensettings.BuildDirSuffix = '_mytarget_rtw'
  %% Callback compatibility declaration
  rtwgensettings.Version = '1';

  %% (OPTIONAL) target inheritance declaration
  rtwgensettings.DerivedFrom = 'ert.tlc';
  %% (OPTIONAL) other rtwGenSettings fields...
         ...
  END_RTW_OPTIONS
%/
%%----------------------------
%% targetComponentClass - MATHWORKS INTERNAL USE ONLY
%% REMOVE NEXT SECTION FROM USER_DEFINED CUSTOM TARGETS
%%----------------------------
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/%
  BEGIN_CONFIGSET_TARGET_COMPONENT
  targetComponentClass = 'Simulink.ERTTargetCC';
  END_CONFIGSET_TARGET_COMPONENT
%/

If you are creating a custom target based on an existing system target file, you must remove the
targetComponentClass section (bounded by the directives
BEGIN_CONFIGSET_TARGET_COMPONENT and END_CONFIGSET_TARGET_COMPONENT). This section
is reserved for the use of targets developed internally by MathWorks.

Header Comments

These lines at the head of the file are formatted as TLC comments. They provide required information
to the System Target File Browser and to the build process. Note that you must place the browser
comments at the head of the file, before other comments or TLC statements.

The presence of the comments enables the code generator to detect system target files. When the
System Target File Browser is opened, the code generator scans the MATLAB path for TLC files that
have formatted header comments. The comments contain the following directives:

• SYSTLC: The descriptor that appears in the browser.
• TMF: Name of the template makefile (TMF) to use during build process. When the target is

selected, this filename is displayed in the “Template makefile” field of the Code Generation pane
of the Configuration Parameters dialog box.

• MAKE: make command to use during build process. When the target is selected, this command is
displayed in the Make command field of the Code Generation pane of the Configuration
Parameters dialog box.

The following header comments are from matlabroot/rtw/c/ert/ert.tlc.
%% SYSTLC: Embedded Coder TMF: ert_default_tmf MAKE: make_rtw
%% SYSTLC: Create Visual C/C++ Solution File for Embedded Coder\
%%    TMF: RTW.MSVCBuild MAKE: make_rtw
.
.
.

Each comment can only contain a maximum of two lines.

If you do not specify the TMF field in the system target file, the file is still valid. To change the value
for theTemplateMakefile parameter, you can instead use the callback function specified by
rtwgensettings.SelectCallback.

You can also use the callback function specified by rtwgensettings.SelectCallback to change
the value for external mode parameters, ExtMode, ExtModeTransport, ExtModeMexFile, or
ExtModeIntrfLevel.

You can specify more than one group of directives in the header comments. Each such group is
displayed as a different target configuration in the System Target File Browser. In the above example,
the first two lines of code specify the default configuration of the ERT target. The next two lines
specify a configuration that creates and builds a Microsoft Visual C++ Solution (.sln) file. The figure
below shows how these configurations appear in the System Target File Browser.
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See “Create a Custom Target Configuration” on page 86-32 for an example of customized header
comments.

TLC Configuration Variables

This section of the system target file assigns global TLC variables that relate to the overall code
generation process.

For an embedded target, in most cases you should simply use the global TLC variable settings used
by the ERT target (ert.tlc). It is especially important that your system target file use the
'Embedded-C' value for the CodeFormat TLC variable and uses the corresponding
rtwgensettings.DerivedFrom = 'ert.tlc' in the RTW_OPTIONS section of the TLC file. Verify
that values are assigned to the following variables:

• CodeFormat: The CodeFormat TLC variable selects generated code features. The 'Embedded-
C' value for this variable is used by the ERT target. Your ERT-based target should specify
'Embedded-C' as the value for CodeFormat. This selection is designed for production code,
minimal memory usage, static memory allocation, and a simplified interface to generated code.

For information on other values for the CodeFormat TLC variable, see “Compare System Target
File Support Across Products”.

• Language: The only valid value is C, which enables support for C or C++ code generation as
specified by the configuration parameter TargetLang.

• TargetType: The code generator defines the preprocessor symbols RT and NRT to distinguish
simulation code from real-time code. These symbols are used in conditional compilation. The
TargetType variable determines whether RT or NRT is defined.

Most targets are intended to generate real-time code. They assign TargetType as follows.

%assign TargetType = "RT"

Some targets, such as the model reference simulation target, accelerated simulation target, RSim
target, and S-function target, generate code for use in nonreal time only. Such targets assign
TargetType as follows.

%assign TargetType = "NRT"

TLC Program Entry Point and Related %includes

The code generation process normally begins with codegenentry.tlc. The system target file
invokes codegenentry.tlc as follows.
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%include "codegenentry.tlc"

Note codegenentry.tlc and the lower-level TLC files assume that CodeFormat, TargetType,
and Language have been assigned. Set these variables before including codegenentry.tlc.

If you need to implement target-specific code generation features, you should include the TLC file
mytarget_genfiles.tlc in your system target file. This file provides a mechanism for executing
custom TLC code before and after invoking codegenentry.tlc. For information on this mechanism,
see

• “Using mytarget_genfiles.tlc” on page 86-30 for an example of custom TLC code for execution
after the main code generation entry point.

• “Target Development and the Build Process” on page 86-13 for general information on the build
process, and for information on other build process customization hooks.

Another way to customize the code generation process is to call lower-level functions (normally
invoked by codegenentry.tlc) directly, and include your own TLC functions at each stage of the
process. This approach should be taken with caution. See “TLC Files” for more information.

The lower-level functions called by codegenentry.tlc are

• genmap.tlc: maps block names to corresponding language-specific block target files.
• commonsetup.tlc: sets up global variables.
• commonentry.tlc: starts the process of generating code.

RTW_OPTIONS Section

The RTW_OPTIONS section is bounded by the directives:

/%
  BEGIN_RTW_OPTIONS
.
.
.
  END_RTW_OPTIONS
%/

The first part of the RTW_OPTIONS section defines an array of rtwoptions structures. This structure
is discussed in “Using rtwoptions to Display Custom Target Options” on page 86-24.

The second part of the RTW_OPTIONS section defines rtwgensettings, a structure defining the
build folder name and other settings for the code generation process. See “rtwgensettings Structure”
on page 86-22 for information about rtwgensettings.

rtwgensettings Structure

The final part of the system target file defines the rtwgensettings structure. This structure stores
information that is written to the model.rtw file and used by the build process. The
rtwgensettings fields of most interest to target developers are

• rtwgensettings.Version: Use this property to enable rtwoptions callbacks and to use the
Callback API in rtwgensettings.SelectCallback.
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Note To use callbacks, you must set:

rtwgensettings.Version = '1';

Add the statement above to the Configure RTW code generation settings section of the system
target file.

• rtwgensettings.DerivedFrom: This structure field defines the system target file from which
options are to be inherited. See “Inheriting Target Options” on page 86-29.

• rtwgensettings.SelectCallback: This structure field specifies a SelectCallback function.
You must set rtwgensettings.Version = '1'; or your callback will be ignored.
SelectCallback is associated with the target rather than with any of its individual options. The
SelectCallback function is triggered when you:

• Load the model.
• Update any configuration settings in the Configuration Parameters dialog box.
• Build the model.

The SelectCallback function is useful for setting up (or disabling) configuration parameters
specific to the target.

The following code installs a SelectCallback function:
rtwgensettings.SelectCallback = 'my_select_callback_handler(hDlg,hSrc)';

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used
by the callback API functions.

Note If you have developed a custom target and you want it to be compatible with model
referencing, you must implement a SelectCallback function to declare model reference
compatibility. See “Support Model Referencing” on page 86-60.

• rtwgensettings.ActivateCallback: this property specifies an ActivateCallback function.
The ActivateCallback function is triggered when the active configuration set of the model
changes. This could happen during model loading, and also when the user changes the active
configuration set.

The following code installs an ActivateCallback function:
rtwgensettings.ActivateCallback = 'my_activate_callback_handler(hDlg,hSrc)';

The arguments to the ActivateCallback function (hDlg,hSrc) are handles to private data
used by the callback API functions.

• rtwgensettings.PostApplyCallback: this property specifies a PostApplyCallback
function. The PostApplyCallback function is triggered when the user clicks the Apply or OK
button after editing options in the Configuration Parameters dialog box. The
PostApplyCallback function is called after the changes have been applied to the configuration
set.

The following code installs an PostApplyCallback function:
rtwgensettings.PostApplyCallback = 'my_postapply_callback_handler(hDlg,hSrc)';
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The arguments to the PostApplyCallback function (hDlg, hSrc) are handles to private data
used by the callback API functions.

• rtwgensettings.BuildDirSuffix: Most targets define a folder name suffix that identifies
build folders created by the target. The build process appends the suffix defined in the
rtwgensettings.BuildDirSuffix field to the model name to form the name of the build
folder. For example, if you define rtwgensettings.BuildDirSuffix as follows

rtwgensettings.BuildDirSuffix = '_mytarget_rtw'

the build folders are named model_mytarget_rtw.

Additional Code Generation Options

“Configure Generated Code with TLC” describes additional TLC code generation variables. End users
of a target can assign these variables by entering a MATLAB command of the form
set_param(modelName,'TLCOptions','-aVariable=val');

(For more information, see “Specify TLC for Code Generation”.)

However, the preferred approach is to assign these variables in the system target file using
statements of the form:
%assign Variable = val

For readability, we recommend that you add such assignments in the section of the system target file
after the comment Configure RTW code generation settings.

Model Reference Considerations

See “Support Model Referencing” on page 86-60 for important information on system target file and
other modifications you may need to make to support the code generator model referencing features.

Define and Display Custom Target Options
• “Using rtwoptions to Display Custom Target Options” on page 86-24
• “Example System Target File With Customized rtwoptions” on page 86-28
• “Inheriting Target Options” on page 86-29

Using rtwoptions to Display Custom Target Options

You control the options to display in the Code Generation pane in the Configuration Parameters
dialog box by customizing the rtwoptions structure in your system target file.

The fields of the rtwoptions structure define variables and associated user interface elements to be
displayed in the Configuration Parameters dialog box. Using the rtwoptions structure array, you
can define target-specific options displayed in the dialog box and organize options into categories.
You can also write callback functions to specify how these options are processed.

When the Code Generation pane opens, the rtwoptions structure array is scanned and the listed
options are displayed. Each option is represented by an assigned user interface element (check box,
edit field, menu, or push button), which displays the current option value.
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The user interface elements can be in an enabled or disabled (appears dimmed) state. If an option is
enabled, the user can change the option value. If an option is disabled, the option uses the default
value and the user cannot change the option value.

You can also use the rtwoptions structure array to define special NonUI elements that cause
callback functions to be executed, but that are not displayed in the Code Generation pane. See
“NonUI Elements” on page 86-27.

The elements of the rtwoptions structure array are organized into groups. Each group of items
begins with a header element of type Category. The default field of a Category header must
contain a count of the remaining elements in the category.

The Category header is followed by options to be displayed on the Code Generation pane. The
header in each category is followed by one or more option definition elements.

Each category of target options corresponds to options listed under Code Generation in the
Configuration Parameters dialog box.

The table rtwoptions Structure Fields Summary summarizes the fields of the rtwoptions structure.

Example rtwoptions Structure

The following rtwoptions structure is excerpted from an example system target file, matlabroot/
toolbox/rtw/rtwdemos/rtwoptions_demo/usertarget.tlc. The code defines an rtwoptions
structure array. The default field of the first (header) element is set to 4, indicating the number of
elements that follow the header.
  rtwoptions(1).prompt        = 'userPreferred target options (I)';
  rtwoptions(1).type          = 'Category';
  rtwoptions(1).enable        = 'on';
  rtwoptions(1).default       = 4;   % number of items under this category
                                     % excluding this one.
  rtwoptions(1).popupstrings  = '';  % At the first item, user has to 
  rtwoptions(1).tlcvariable   = '';  % initialize all supported fields
  rtwoptions(1).tooltip       = '';
  rtwoptions(1).callback      = '';
  rtwoptions(1).makevariable  = '';

  rtwoptions(2).prompt        = 'Execution Mode';
  rtwoptions(2).type          = 'Popup';
  rtwoptions(2).default       = 'Real-Time';
  rtwoptions(2).popupstrings  = 'Real-Time|UserDefined';
  rtwoptions(2).tlcvariable   = 'tlcvariable1';
  rtwoptions(2).tooltip       = ['See this text as tooltip'];

  rtwoptions(3).prompt        = 'Log Execution Time';
  rtwoptions(3).type          = 'Checkbox';
  rtwoptions(3).default       = 'on';
  rtwoptions(3).tlcvariable   = 'RL32LogTETModifier';
  rtwoptions(3).tooltip       = ['']; % no tooltip

  rtwoptions(4).prompt        = 'Real-Time Interrupt Source';
  rtwoptions(4).type          = 'Popup';
  rtwoptions(4).default       = 'Timer';
  rtwoptions(4).popupstrings  = 'Timer|5|6|7|8|9|10|11|12|13|14|15';
  rtwoptions(4).tlcvariable   = 'tlcvariable3';
  rtwoptions(4).callback      = 'usertargetcallback(hDlg, hSrc, ''tlcvariable3'')';
  rtwoptions(4).tooltip       = [''];
  rtwoptions(4).tooltip       = ['See TLC file for how to use reserved '...
    ' keyword ''hDlg'', and ''hSrc''.'];
...
  rtwoptions(5).prompt        = 'Signal Logging Buffer Size in Doubles';
  rtwoptions(5).type          = 'Edit';
  rtwoptions(5).default       = '100000';
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  rtwoptions(5).tlcvariable   = 'tlcvariable2';
  rtwoptions(5).tooltip       = [''];

The first element adds a userPreferred target options (I) pane under Code Generation in the
Configuration Parameters dialog box. The pane displays the options defined in rtwoptions(2),
rtwoptions(3), rtwoptions(4), and rtwoptions(5).

If you want to define a large number of options, you can define multiple Category groups within a
single system target file.

Note the rtwoptions structure and callbacks are written in MATLAB code, although they are
embedded in a TLC file. To verify the syntax of your rtwoptions structure definitions and code, you
can execute the commands at the MATLAB prompt by copying and pasting them to the MATLAB
Command Window.

To learn more about usertarget.tlc and the example callback files provided with it, see “Example
System Target File With Customized rtwoptions” on page 86-28. For more examples of target-
specific rtwoptions definitions, see the target.tlc files under matlabroot/rtw/c (open).

rtwoptions Structure Fields Summary lists the fields of the rtwoptions structure.
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rtwoptions Structure Fields Summary
Field Name Description
callback For examples of callback usage, see “Example System Target File With

Customized rtwoptions” on page 86-28.
closecallback
(obsolete)

Do not use closecallback.
Use rtwgensettings.PostApplyCallback instead (see
“rtwgensettings Structure” on page 86-22).

closecallback is ignored.

For examples of callback usage, see “Example System Target File With
Customized rtwoptions” on page 86-28.

default Default value of the option (empty if the type is Pushbutton).
enable Must be 'on' or 'off'. If 'on', the option is displayed as an enabled

item; otherwise, as a disabled item.
makevariable Template makefile token (if any) associated with the option. The

makevariable is expanded during processing of the template makefile.
See “Template Makefile Tokens” on page 86-43.

modelReferenceParameter‐
Check

Specifies whether the option must have the same value in a referenced
model and its parent model. If this field is unspecified or has the value
'on' the option values must be same. If the field is specified and has the
value 'off' the option values can differ. See “Controlling Configuration
Option Value Agreement” on page 86-63.

NonUI Element that is not displayed, but is used to invoke a close or open
callback. See “NonUI Elements” on page 86-27.

opencallback
(obsolete)

Do not use opencallback.
Use rtwgensettings.SelectCallback instead (see “rtwgensettings
Structure” on page 86-22).

For examples of callback usage, see “Example System Target File With
Customized rtwoptions” on page 86-28.

popupstrings If type is Popup, popupstrings defines the items in the menu. Items are
delimited by the "|" (vertical bar) character. The following example defines
the items of the MAT-file variable name modifier menu used by the GRT
target.

'rt_|_rt|none'

prompt Label for the option.
tlcvariable Name of TLC variable associated with the option.
tooltip Help text displayed when mouse is over the item.
type Type of element: Checkbox, Edit, NonUI, Popup, Pushbutton, or

Category.

NonUI Elements

Elements of the rtwoptions array that have type NonUI exist solely to invoke callbacks. A NonUI
element is not displayed in the Configuration Parameters dialog box. You can use a NonUI element if
you want to execute a callback that is not associated with a user interface element, when the dialog
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box opens or closes. See the next section, “Example System Target File With Customized rtwoptions”
on page 86-28 for an example.

Note The default value of an element of type NonUI or Edit determines the set of values allowed for
that element.

• If the default value is '0' or '1':

• For type NonUI, the element stores a Boolean value.
• For type Edit, the element stores a value of type int32.

• If the default value contains an integer other than '0' or '1', the element stores a value of type
int32.

• If the default value does not contain an integer, the element is evaluated as a character vector.

Example System Target File With Customized rtwoptions

A working system target file, with MATLAB file callback functions, has been provided as an example
of how to use the rtwoptions structure to display and process custom options on the Code
Generation pane. The examples are compatible with the callback API.

The example target files are in the folder (open):

matlabroot/toolbox/rtw/rtwdemos/rtwoptions_demo

The example target files include:

• usertarget.tlc: The example system target file. This file illustrates how to define custom
menus, check boxes, and edit fields. The file also illustrates the use of callbacks.

• usertargetcallback.m: A MATLAB file callback invoked by a menu.

Refer to the example files while reading this section. The example system target file,
usertarget.tlc: illustrates the use of rtwoptions to display the following custom target options:

• The Execution Mode menu.
• The Log Execution Time check box.
• The Real-Time Interrupt Source menu. The menu executes a callback defined in an external file,

usertargetcallback.m. The TLC variable associated with the menu is passed in to the
callback, which displays the menu's current value.

• The edit field Signal Logging Buffer Size in Doubles.

Try studying the example code while interacting with the example target options in the Configuration
Parameters dialog box. To interact with the example target file,

1 Make matlabroot/toolbox/rtw/rtwdemos/rtwoptions_demo (open) your working folder.
2 Open a model of your choice.
3 Open the Configuration Parameters dialog box and select the Code Generation pane.
4 Click Browse. The System Target File Browser opens. Select usertarget.tlc. Then click OK.
5 Observe that the Code Generation pane contains a custom sub-tab: userPreferred target

options (I).
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6 As you interact with the options in this category and open and close the Configuration
Parameters dialog box, observe the messages displayed in the MATLAB Command Window. These
messages are printed from code in the system target file, or from callbacks invoked from the
system target file.

Inheriting Target Options

ert.tlc provides a basic set of Embedded Coder code generation options. If your target is based on
ert.tlc, your system target file should normally inherit the options defined in ERT.

Use the rtwgensettings.DerivedFrom field in the rtwgensettings structure to define the
system target file from which options are to be inherited. You should convert your custom target to
use this mechanism as follows.

Set the rtwgensettings.DerivedFrom field value as in the following example:

rtwgensettings.DerivedFrom = 'stf.tlc';

where stf is the name of the system target file from which options are to be inherited. For example:

rtwgensettings.DerivedFrom = 'ert.tlc';

When the Configuration Parameters dialog box executes this line of code, it includes the options from
stf.tlc automatically. If stf.tlc is a MathWorks internal system target file that has been
converted to a new layout, the dialog box displays the inherited options using the new layout.

Handling Unsupported Options

If your target does not support all of the options inherited from ert.tlc, you should detect
unsupported option settings and display a warning or error message. In some cases, if a user has
selected an option your target does not support, you may need to abort the build process. For
example, if your target does not support the Generate an example main program option, the build
process should not be allowed to proceed if that option is selected.

Even though your target may not support all inherited ERT options, it is required that the ERT
options are retained in the Code Generation pane of the Configuration Parameters dialog box. Do
not simply remove unsupported options from the rtwoptions structure in the system target file.
Options must be in the dialog box to be scanned by the code generator when it performs
optimizations.

For example, you may want to prevent users from turning off the Single output/update function
option. It may seem reasonable to remove this option from the dialog box and simply assign the TLC
variable CombineOutputUpdateFcns to on. However, if the option is not included in the dialog box,
the code generator assumes that output and update functions are not to be combined. Less efficient
code is generated as a result.

Tips and Techniques for Customizing Your System Target File
• “Introduction” on page 86-30
• “Required and Recommended %includes” on page 86-30
• “Handling Aliases for Target Option Values” on page 86-30
• “Supporting Multiple Development Environments” on page 86-32
• “Updating Your Custom System Target File” on page 86-32
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Introduction

The following sections include information on techniques for customizing your system target file,
including:

• How to invoke custom TLC code from your system target file
• Approaches to supporting multiple development environments
• Considerations for when you update your system target file

Required and Recommended %includes

If you need to implement target-specific code generation features, we recommend that your system
target file include the TLC file mytarget_genfiles.tlc.

Once your system target file has set up the required TLC environment, you must include
codegenentry.tlc to start the standard code generation process.

mytarget_genfiles.tlc provides a mechanism for executing custom TLC code after the main
code generation entry point. See “Using mytarget_genfiles.tlc” on page 86-30.
Using mytarget_genfiles.tlc

mytarget_genfiles.tlc (optional) is useful as a central file from which to invoke target-specific
TLC files that generate additional files as part of your target build process. For example, your target
may create sub-makefiles or project files for a development environment, or command scripts for a
debugger to do automatic downloads.

The build process can then invoke these generated files either directly from the make process or after
the executable is created. This is done with the STF_make_rtw_hook.m mechanism, as described in
“Customize Build Process with STF_make_rtw_hook File”.

The following TLC code shows an example mytarget_genfiles.tlc file.

%selectfile NULL_FILE

%assign ModelName = CompiledModel.Name

%% Create Debugger script
%assign model_script_file = "%<ModelName>.cfg"
%assign script_file = "debugger_script_template.tlc"

%if RTWVerbose
   %selectfile STDOUT
   ### Creating %<model_script_file>
   %selectfile NULL_FILE
%endif

%include "%<script_file>"
%openfile bld_file = "%<model_script_file>"
%<CreateDebuggerScript()>
%closefile bld_file

Handling Aliases for Target Option Values

This section describes utility functions that can be used to detect and resolve alias values or legacy
values when testing user-specified values for the target device type (ProdHWDeviceType) and the
code replacement library (CodeReplacementLibrary).
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RTW.isHWDeviceTypeEq

To test if two target device type values represent the same hardware device, invoke the following
function:

result = RTW.isHWDeviceTypeEq(type1,type2)

where type1 and type2 are character vectors containing target device type values or aliases.

The RTW.isHWDeviceTypeEq function returns true if type1 and type2 are character vectors
representing the same hardware device. For example, the following call returns true:

RTW.isHWDeviceTypeEq('Specified','Generic->Custom')

For a description of the target device type option ProdHWDeviceType, see the command-line
information for the Hardware Implementation pane parameters “Device vendor” and “Device
type”.
RTW.resolveHWDeviceType

To return the device type value for a hardware device, given a value that might be an alias or legacy
value, invoke the following function:

result = RTW.resolveHWDeviceType(type)

where type is a character vector containing a target device type value or alias.

The RTW.resolveHWDeviceType function returns the device type value of the device. For example,
the following calls both return 'Generic->Custom':

RTW.resolveHWDeviceType('Specified')
RTW.resolveHWDeviceType('Generic->Custom')

For a description of the target device type option ProdHWDeviceType, see the command-line
information for the Hardware Implementation pane parameters “Device vendor” and “Device
type”.
RTW.isTflEq

To test if two code replacement library (CRL) names represent the same CRL, invoke the following
function:

result = RTW.isTflEq(name1,name2)

where name1 and name2 are character vectors containing CRL values or aliases.

The RTW.isTflEq function returns true if name1 and name2 are character vectors representing the
same code replacement library. For example, the following call returns true:

RTW.isTflEq('GNU','GNU C99 extensions')

For a description of the CodeReplacementLibrary parameter, see “Code replacement library”.
RTW.resolveTflName

To return the CRL value for a code replacement library, given a value that might be an alias or legacy
value, invoke the following function:

result = RTW.resolveTflName(name)
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where name is a character vector containing a CRL value or alias.

The RTW.resolveTflName function returns the value of the referenced code replacement library.
For example, the following calls both return 'GNU C99 extensions':

RTW.resolveTflName('GNU')
RTW.resolveTflName('GNU C99 extensions')

For a description of the CodeReplacementLibrary parameter, see “Code replacement library”.

Supporting Multiple Development Environments

Your target may require support for multiple development environments (for example, two or more
cross-compilers) or multiple modes of code generation (for example, generating a binary executable
versus generating a project file for your compiler).

One approach to this requirement is to implement multiple system target files. Each system target file
invokes a template makefile for the development environment. This amounts to providing two
separate targets.

Updating Your Custom System Target File

Updating your custom system target file can impact the option values of a model that you load that
uses the updated system target file. If you disable an option, the updated system target file uses the
default value for that option. If a model has a different value for that option, when you load the model
with the updated system target file, the value from the model is discarded and the system target file
uses the default value instead.

Create a Custom Target Configuration
• “Introduction” on page 86-32
• “my_ert_target Overview” on page 86-33
• “Creating Target Folders” on page 86-34
• “Create ERT-Based, Toolchain Compliant System Target File” on page 86-34
• “Create ERT-Based Template MakeFile” on page 86-39
• “Create Test Model and S-Function” on page 86-40
• “Verify Target Operation” on page 86-41

Introduction

This tutorial can supplement the example target guides described in “Sample Custom Targets” on
page 86-3. For an introduction and example files, try the example targets first.

This tutorial guided you through the process of creating an ERT-based target, my_ert_target. This
exercise illustrates several tasks, which are typical for creating a custom target:

• Setting up target folders and modifying the MATLAB path.
• Making modifications to a standard system target file and TMF such that the custom target is

visible in the System Target File Browser, inherits ERT options, displays target-specific options,
and generates code with the default host-based compiler.

• Testing the build process with the custom target, using a simple model that incorporates an
inlined S-function.
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During this exercise, you implement an operational, but skeletal, ERT-based target. This target can be
useful as a starting point in a complete implementation of a custom embedded target.

my_ert_target Overview

In the following sections, you create a skeletal target, my_ert_target. The target inherits and
supports the standard options of the ERT target and displays additional target-specific options in the
Configuration Parameters dialog box (see “Target-Specific Options for my_ert_target” on page 86-
33).

Target-Specific Options for my_ert_target

my_ert_target supports a toolchain-based build, generating code and executables that run on the
host system. my_ert_target uses the lcc compiler on a Microsoft Windows platform. The chosen
compiler is readily available and is distributed with the code generator. On a Microsoft Windows
platform, if you use a different compiler, you can set up lcc temporarily as your default compiler
through the following MATLAB command:
mex -setup

The software displays links for supported compilers that are installed on your computer. Click the
lcc link.
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Note On Linux systems, make sure that you have an installed C compiler. If so, you can use Linux
folder syntax to complete this exercise.

my_ert_target can also support template makefile-based builds. For more information about using
this target with the template makefile approach, see “Create ERT-Based Template MakeFile” on page
86-39.

You can test my_ert_target with a model that is compatible with the ERT target (see “Configure a
System Target File” on page 48-2). Generated programs operate identically to ERT generated
programs.

To simplify the testing of your target, test with targetmodel, a very simple fixed-step model (see
“Create Test Model and S-Function” on page 86-40). The S-Function block in targetmodel uses the
source code from the timestwo example, and generates fully inlined code. See “S-Function
Examples” and “Inline S-Functions with TLC” for further discussion of the timestwo example S-
function.

Creating Target Folders

Create folders to store the target files and add them to the MATLAB path, following the
recommended conventions (see “Folder and File Naming Conventions” on page 86-5). You also create
a folder to store the test model, S-function, and generated code.

This example assumes that your target and model folders are located within the folder c:/work. Do
not place your target and model folders within the MATLAB folder tree (that is, in or under the
matlabroot folder).

To create the folders and make them accessible:

1 Create a target root folder, my_ert_target. From the MATLAB Command Window on a
Windows platform, enter:
cd c:/work
mkdir my_ert_target

2 Within the target root folder, create a subfolder to store your target files.
mkdir my_ert_target/my_ert_target

3 Add these folders to your MATLAB path.
addpath c:/work/my_ert_target
addpath c:/work/my_ert_target/my_ert_target

4 Create a folder, my_targetmodel, to store the test model, S-function, and generated code.
mkdir my_targetmodel

Create ERT-Based, Toolchain Compliant System Target File

Create a system target file for your target by copying and modifying the standard system target file
for the ERT target. Then, validate the system target file by viewing the new target in the System
Target File Browser and in the Configuration Parameters dialog box.

Editing the System Target File

To edit the system target file, use these steps:

1 Change your working folder to the folder you created in “Creating Target Folders” on page 86-34.
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cd c:/work/my_ert_target/my_ert_target

2 Place a copy of matlabroot/rtw/c/ert/ert.tlc in c:/work/my_ert_target/
my_ert_target and rename it to my_ert_target.tlc. The file ert.tlc is the system target
file for the ERT target.

3 Open my_ert_target.tlc in a text editor of your choice.
4 Customize the system target file, replacing the header comment lines with directives that make

your system target file visible in the System Target File Browser and define the associated TMF,
make command, and external mode interface file (if any). For more information about these
directives, see “Header Comments” on page 86-20 .

Replace the header comments in my_ert_target.tlc with the following header comments.
%% SYSTLC: My ERT-based Target TMF: my_ert_target_lcc.tmf MAKE: make_rtw

5 The file my_ert_target.tlc inherits the standard ERT options, using the mechanism described
in “Inheriting Target Options” on page 86-29. Therefore, the existing rtwoptions structure
definition is superfluous. Edit the RTW_OPTIONS section such that it includes only the following
code.
/%
  BEGIN_RTW_OPTIONS

  %----------------------------------------%
  % Configure RTW code generation settings %
  %----------------------------------------%

  rtwgensettings.BuildDirSuffix = '_ert_rtw';

  END_RTW_OPTIONS
 %/

6 Delete the code after the end of the RTW_OPTIONS section, which is delimited by the directives
BEGIN_CONFIGSET_TARGET_COMPONENT and END_CONFIGSET_TARGET_COMPONENT. This
code is for use only by internal MathWorks developers.

7 Modify the build folder suffix in the rtwgenSettings structure in accordance with the
conventions described in “rtwgensettings Structure” on page 86-22.

To set the suffix to a character vector for the _my_ert_target custom target, change the line
rtwgensettings.BuildDirSuffix = '_ert_rtw'

to
rtwgensettings.BuildDirSuffix = '_my_ert_target_rtw'

8 Modify the rtwgenSettings structure to inherit options from the ERT target and declare
Release 14 or later compatibility as described in “rtwgensettings Structure” on page 86-22. Add
the following code to the rtwgenSettings definition:

rtwgensettings.DerivedFrom = 'ert.tlc';
rtwgensettings.Version = '1';

9 Add an rtwoptions structure that defines a target-specific options category with three check
boxes just after the BEGIN_RTW_OPTIONS directive. The following code shows the complete
RTW_OPTIONS section, including the previous rtwgenSettings changes.
/%
  BEGIN_RTW_OPTIONS

  rtwoptions(1).prompt         = 'My Target Options';
  rtwoptions(1).type           = 'Category';
  rtwoptions(1).enable         = 'on';
  rtwoptions(1).default        = 3;   % number of items under this category
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                                      % excluding this one.
  rtwoptions(1).popupstrings  = '';
  rtwoptions(1).tlcvariable   = '';
  rtwoptions(1).tooltip       = '';
  rtwoptions(1).callback      = '';
  rtwoptions(1).makevariable  = '';

  rtwoptions(2).prompt         = 'Demo option 1';
  rtwoptions(2).type           = 'Checkbox';
  rtwoptions(2).default        = 'off';
  rtwoptions(2).tlcvariable    = 'DummyOpt1';
  rtwoptions(2).makevariable   = '';
  rtwoptions(2).tooltip        = ['Demo option1 (non-functional)'];
  rtwoptions(2).callback       = '';

  rtwoptions(3).prompt         = 'Demo option 2';
  rtwoptions(3).type           = 'Checkbox';
  rtwoptions(3).default        = 'off';
  rtwoptions(3).tlcvariable    = 'DummyOpt2';
  rtwoptions(3).makevariable   = '';
  rtwoptions(3).tooltip        = ['Demo option2 (non-functional)'];
  rtwoptions(3).callback       = '';

  rtwoptions(4).prompt         = 'Demo option 3';
  rtwoptions(4).type           = 'Checkbox';
  rtwoptions(4).default        = 'off';
  rtwoptions(4).tlcvariable    = 'DummyOpt3';
  rtwoptions(4).makevariable   = '';
  rtwoptions(4).tooltip        = ['Demo option3 (non-functional)'];
  rtwoptions(4).callback       = '';

  %----------------------------------------%
  % Configure RTW code generation settings %
  %----------------------------------------%

  rtwgensettings.BuildDirSuffix = '_my_ert_target_rtw';
  rtwgensettings.DerivedFrom = 'ert.tlc';
  rtwgensettings.Version = '1';
  rtwgensettings.SelectCallback = 'enableToolchainCompliant(hSrc, hDlg)';
  %SelectCallback provides toolchain approach support, but requires custom function
  %Omit this SelectCallback if using the template makefile approach

  END_RTW_OPTIONS
%/

10 Save your changes to my_ert_target.tlc and close the file.

Create ToolchainCompliant Function

To enable builds using the toolchain approach, you create a function that corresponds to the
SelectCallback near the end of the custom system target file. This function sets properties for
toolchain compliance.
function enableToolchainCompliant(hSrc, hDlg)
  % The following parameters enable toolchain compliance.
  slConfigUISetVal(hDlg, hSrc, 'UseToolchainInfoCompliant', 'on');
  slConfigUISetVal(hDlg, hSrc, 'GenerateMakefile','on');
  
  % The following parameters are not required for toolchain compliance.
  % But, it is recommended practice to set these default values and 
  % disable the parameters (as shown).
  slConfigUISetVal(hDlg, hSrc, 'RTWCompilerOptimization','off');
  slConfigUISetVal(hDlg, hSrc, 'MakeCommand','make_rtw');
  slConfigUISetEnabled(hDlg, hSrc, 'RTWCompilerOptimization',false);
  slConfigUISetEnabled(hDlg, hSrc, 'MakeCommand',false);
  hSrc.refreshDialog;
end
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Note If you are using the template makefile approach, omit calling the function enabling toolchain-
compliance from your system target file. Instead, use the information in “Create ERT-Based Template
MakeFile” on page 86-39.

Viewing the System Target File

At this point, you can verify that the target inherits and displays ERT options as follows:

1 Create a new model.
2 Open the Model Explorer or the Configuration Parameters dialog box.
3 Select the Code Generation pane.
4 Click Browse to open the System Target File browser.
5 In the file browser, scroll through the list of targets to find the new target,

my_ert_target.tlc. (This step assumes that your MATLAB path contains c:/work/
my_ert_target/my_ert_target, as previously set in “Creating Target Folders” on page 86-
34.)

6 Select My ERT-based Target and click OK.

7 The Code Generation pane now shows that the model is configured for the
my_ert_target.tlc target. The System target file, Language, Toolchain, and Build
configuration fields should appear:
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8 Select the My Target Options pane. The target displays the three check box options defined in
the rtwoptions structure.
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9 Select the Code Generation pane and reopen the System Target File Browser.
10 Select the Embedded Coder target (ert.tlc). The target displays the standard ERT options.
11 Close the model. You do not need to save it.

The system target file for the skeletal target is complete. If you are using the toolchain approach, you
are ready to invoke the build process for your target.

If you prefer to use the template makefile approach, the reference to a TMF,
my_ert_target_lcc.tmf, in the system target file header comments prevents you from invoking
the build process for your target until the TMF file is in place. First, you must create a
my_ert_target_lcc.tmf file.

Create ERT-Based Template MakeFile

If you are using the toolchain makefile approach with a toolchain compliant custom target, omit the
steps that apply to the template makefile approach. (Skip this section.)

If you are using the template makefile approach, follow the steps that apply to a template makefile
and omit calling the function that enables toolchain-compliance from your system target file, which is
described in “Create ERT-Based, Toolchain Compliant System Target File” on page 86-34.
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Create a template makefile for your target by copying and modifying a supplied ERT template
makefile. Select the template makefile that fits your target best. This example uses ert_lcc64.tmf,
but you can also use ert_vcx64.tmf or ert_unix.tmf.

1 Make sure that your working folder is still set to the target file folder you created previously in
“Creating Target Folders” on page 86-34.
c:/work/my_ert_target/my_ert_target

2 Place a copy of matlabroot/toolbox/coder/compile/tmf/ert_lcc64.tmf in c:/work/
my_ert_target/my_ert_target and rename it my_ert_target_lcc.tmf. The file
ert_lcc64.tmf is the ERT compiler-specific template makefile for the LCC compiler.

3 Open my_ert_target_lcc.tmf in a text editor.
4 Change the SYS_TARGET_FILE parameter so that the file reference for your .tlc file is

generated in the make file. Change the line
SYS_TARGET_FILE = any

to
SYS_TARGET_FILE = my_ert_target.tlc

5 Save changes to my_ert_target_lcc.tmf and close the file.

Your target can now generate code and build a host-based executable. In the next sections, you create
a test model and test the build process using my_ert_target.

Create Test Model and S-Function

In this section, you build a simple test model for later use in code generation:

1 Set your working folder to c:/work/my_targetmodel.
cd c:/work/my_targetmodel

For the remainder of this tutorial, my_targetmodel is assumed to be the working folder. Your
target writes the output files of the code generation process into a build folder within the
working folder. When inlined code is generated for the timestwo S-function, the build process
looks for the TLC implementation of the S-function in the working folder.

2 Copy the following C and TLC files for the timestwo S-function to your working folder:

• matlabroot/toolbox/simulink/simdemos/simfeatures/src/timestwo.c
• matlabroot/toolbox/simulink/simdemos/simfeatures/tlc_c/timestwo.tlc

3 Build the timestwo MEX-file in c:/work/my_targetmodel.
mex timestwo.c

4 Create the following model, using an S-Function block from the Simulink User-Defined Functions
library. Save the model in your working folder as targetmodel.

5 Double-click the S-Function block to open the Block Parameters dialog box. Enter the S-function
name timestwo. Click OK. The block is now bound to the timestwo MEX-file.
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6 Open Model Explorer or the Configuration Parameters dialog box and select the Solver pane.
7 Set the solver Type to fixed-step and click Apply.
8 Save the model.
9 Open the scope and run a simulation. Verify that the timestwo S-function multiplies its input by

2.0.

Keep the targetmodel model open for use in the next section, in which you generate code using the
test model.

Verify Target Operation

In this section you configure targetmodel for the my_ert_target custom target, and use the
target to generate code and build an executable:

1 In the Configuration Parameters dialog box, select the Code Generation pane.
2 Click Browse to open the System Target File Browser.
3 In the Browser, select My ERT-based Target and click OK.
4 The Configuration Parameters dialog box now displays the Code Generation pane for

my_ert_target.
5 Select the Code Generation > Report pane and select the Create code generation report

option.
6 Click Apply and save the model. The model is configured for my_ert_target.
7 Build the model. If the build succeeds, the MATLAB Command Window displays the message

below.
### Created executable: ../targetmodel.exe
### Successful completion of build procedure for model:
targetmodel

Your working folder contains the targetmodel.exe file and the build folder,
targetmodel_my_ert_target_rtw, which contains generated code and other files. The
working folder also contains an slprj folder, used internally by the build process.

The code generator also creates a code generation report.
8 To view the generated code, on the C Code tab, click View Code. In the Contents pane of the

code generation report, click the targetmodel.c link.
9 In targetmodel.c, locate the model step function, targetmodel_step. Observe the following

code.
/* S-Function Block: <Root>/S-Function */
/* Multiply input by two */
targetmodel_B.SFunction = targetmodel_B.SineWave * 2.0;

The presence of this code confirms that the my_ert_target custom target has generated an
inlined output computation for the S-Function block in the model.

See Also

More About
• “Custom Targets”
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• “Support Toolchain Approach with Custom Target”
• “Support Model Referencing”
• “Support Compiler Optimization Level Control”
• “Support C Function Prototype Control”
• “Support C++ Class Interface Control”
• “Support Concurrent Execution of Multiple Tasks”
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Customize Template Makefiles
To configure or customize a template makefile (TMF), you should be familiar with how the make
command works and how it processes a makefile (.mk file). You should also understand makefile build
rules. For information on these topics, refer to the documentation provided with the make utility that
you use.

Template Makefiles and Tokens
A template makefile contains tokens. The build process expands the tokens and creates makefiles:

• model.mk –– Compiles and links code generated from model components.
• rtwshared.mk –– Compiles generated shared utility code.

The makefiles (model_or_sharedutils.mk) use commands that are specific to your development
computer.

Template Makefile Tokens

The make_rtw command (or a different command provided with some targets) directs the process of
generating model_or_sharedutils.mk. The make_rtw command processes the TMF specified on
the Code Generation pane of the Configuration Parameters dialog box. make_rtw copies the TMF,
line by line, expanding each token encountered. Template Makefile Tokens Expanded by make_rtw
lists the tokens and their expansions.

These tokens are used in several ways by the expanded makefile:

• To control the conditional behavior in the makefile. The conditionals are used to control the source
file lists, library names, target to be built, and other build-related information.

• To provide the macro definitions for compiling the files, for example, -DINTEGER_CODE=1.
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Template Makefile Tokens Expanded by make_rtw

Token Expansion
General purpose
|>ADDITIONAL_LDFLAGS<| Linker flags automatically added by blocks.
|>ALT_MATLAB_BIN<| Alternate full pathname for the MATLAB executable; value is

different than value for MATLAB_BIN token when the full
pathname contains spaces.

|>ALT_MATLAB_ROOT<| Alternate full pathname for the MATLAB installation; value is
different than value for MATLAB_ROOT token when the full
pathname contains spaces.

|>BUILDARGS<| Options passed to make_rtw. This token is provided so that
the contents of your model_or_sharedutils.mk file
change when you change the build arguments, thus forcing
an update of modules when your build options change.

|>COMBINE_OUTPUT_UPDATE_FCNS<| True (1) when you select model configuration parameter
Single output/update function, otherwise False (0). Used
for the macro definition -DONESTEPFCN=1.

|>COMPILE_FLAGS_OTHER<| Compiler flags in a group other than 'OPTS', 'OPT_OPTS',
and 'OPTIMIZATION_FLAGS'. The build process produces a
warning if |>COMPILE_FLAGS_OTHER<| is absent and these
conditions apply:

• The build information contains a compiler flag that is not
in 'OPTS', 'OPT_OPTS', or 'OPTIMIZATION_FLAGS'.

• The compiler flag is not in the template makefile.
|>COMPUTER<| Computer type. See the MATLAB computer command.
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Token Expansion
|>DEFINES_OTHER<| Preprocessor macro definitions in a group other than

'OPTS', 'OPT_OPTS', 'OPTIMIZATION_FLAGS', and
'Custom'.

A preprocessor macro definition in 'OPTS', 'OPT_OPTS',
'OPTIMIZATION_FLAGS', or 'Custom' that has a
corresponding variable/token pair in the template makefile is
not expanded in DEFINES_OTHER. This behavior helps to
avoid the provision of duplicate preprocessor macro
definitions.

For example, some template makefiles contain these
statements:

...
NUMST = |>NUMST<|
...
CPP_REQ_DEFINES1 = ... -DNUMST=$(NUMST) ...

If the template makefile contains the variable/token pair
NUMST = |>NUMST<| and NUMST is a preprocessor macro
definition in buildInfo, then the build process does not
expand it in DEFINES_OTHER.

The build process produces a warning if |
>DEFINES_OTHER<| is absent and these conditions apply:

• The build information contains a preprocessor macro
definition that is not in 'OPTS', 'OPT_OPTS',
'OPTIMIZATION_FLAGS', or 'Custom'.

• The preprocessor macro definition, for example, NUMST, is
not in the template makefile.

|>EXPAND_LIBRARY_LOCATION<| Location of precompiled library file. The
TargetPreCompLibLocation configuration parameter can
override this setting. For examples, see “Control Library
Location and Naming During Build”.

|>EXPAND_LIBRARY_NAME<| Library name. For examples, see “Control Library Location
and Naming During Build” and “Modify the Template
Makefile for rtwmakecfg”.

|>EXPAND_LIBRARY_SUFFIX<| Library suffix. The TargetLibSuffix configuration
parameter can override this setting. For examples, see
“Control Library Location and Naming During Build”.

|>EXT_MODE<| (Not required for R2018a and
later provided template makefile specifies
TOOLCHAIN_NAME)

True (1) to enable generation of external mode support code,
otherwise False (0).

|>EXTMODE_TRANSPORT<| (Not required for
R2018a and later provided template makefile
specifies TOOLCHAIN_NAME)

Index of transport mechanism (for example, tcpip, serial)
for external mode.
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Token Expansion
|>EXTMODE_STATIC<| (Not required for
R2018a and later provided template makefile
specifies TOOLCHAIN_NAME)

True (1) if static memory allocation is selected for external
mode. False (0) if dynamic memory allocation is selected.

|>EXTMODE_STATIC_SIZE<| (Not required for
R2018a and later provided template makefile
specifies TOOLCHAIN_NAME)

Size of static memory allocation buffer for external mode.

|>GENERATE_ERT_S_FUNCTION<| True (1) when model configuration parameter Create block
is set to SIL, otherwise False (0). Used for control of the
makefile target of the build.

|>INCLUDE_MDL_TERMINATE_FCN<| True (1) when model configuration parameter Terminate
function required is selected, otherwise False (0). Used for
the macro definition -DTERMFCN==1.

|>INTEGER_CODE<| True (1) when model configuration parameter Support
floating-point numbers is cleared, otherwise False (0).
INTEGER_CODE is a required macro definition when
compiling the source code and is used when selecting
precompiled libraries to link against.

|>MAKEFILE_NAME<| model_or_sharedutils.mk — The name of the makefile
that was created from the TMF.

|>MAT_FILE<| True (1) when model configuration parameter MAT-file
logging is selected, otherwise False (0). MAT_FILE is a
required macro definition when compiling the source code
and also is used to include logging code in the build process.

|>MATLAB_BIN<| Location of the MATLAB executable program.
|>MATLAB_ROOT<| Path to where MATLAB is installed.
|>MEM_ALLOC<| RT_MALLOC or RT_STATIC. Indicates how memory is to be

allocated.
|>MEXEXT<| MEX-file extension. See the MATLAB mexext command.
|>MODEL_MODULES<| Additional generated source modules. For example, you can

split a large model into two files, model.c and model1.c. In
this case, this token expands to model1.c.

|>MODEL_MODULES_OBJ<| Object filenames (.obj) corresponding to additional
generated source modules.

|>MODEL_NAME<| Name of the Simulink block diagram currently being built.
|>MULTITASKING<| True (1) if solver mode is multitasking, otherwise False (0).
|>NCSTATES<| Number of continuous states.
|>NUMST<| Number of sample times in the model.
|>RELEASE_VERSION<| The MATLAB release version.
|>S_FUNCTIONS_LIB<| List of S-function libraries available for linking.
|>SOLVER<| Solver source filename, for example, ode3.c.
|>SOLVER_OBJ<| Solver object (.obj) filename, for example, ode3.obj.
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Token Expansion
|>TARGET_LANG_EXT<| c when model configuration parameter Language is set to C,

cpp when Language is set to C++. Used in the makefile to
control the extension on generated source files.

|>TID01EQ<| True (1) if sampling rates of the continuous task and the first
discrete task are equal, otherwise False (0).

S-function and build information support

Note For examples of the tokens in this section, see “Modify the Template Makefile for rtwmakecfg”.
|>START_EXPAND_INCLUDES<|
|>EXPAND_DIR_NAME<|
|>END_EXPAND_INCLUDES<|

List of folder names to add to the include path. Additionally,
the ADD_INCLUDES macro must be added to the INCLUDES
line.

|>START_EXPAND_LIBRARIES<|
|>EXPAND_LIBRARY_NAME<|
|>END_EXPAND_LIBRARIES<|

List of library names.

|>START_EXPAND_MODULES<|
|>EXPAND_MODULE_NAME<|
|>END_EXPAND_MODULES<|

Library module names within |
>START_EXPAND_LIBRARIES<| and |
>START_PRECOMP_LIBRARIES<| library lists.

|>START_EXPAND_RULES<|
|>EXPAND_DIR_NAME<|
|>END_EXPAND_RULES<|

Makefile rules.

|>START_PRECOMP_LIBRARIES<|
|>EXPAND_LIBRARY_NAME<|
|>END_PRECOMP_LIBRARIES<|

List of precompiled library names.

Model reference support

Note For examples of the tokens in this section, see “Providing Model Referencing Support in the TMF” on
page 86-60.
|>MASTER_ANCHOR_DIR<| For parallel builds, current work folder (pwd) at the time the

build started.
|>MODELLIB<| Name of the library file generated for the current model.
|>MODELREFS<| List of models referenced by the top model.
|>MODELREF_LINK_LIBS<| List of referenced model libraries against which the top

model links.
|>MODELREF_LINK_RSPFILE_NAME<| Name of a response file against which the top model links.

This token is valid only for build environments that support
linker response files. For an example of its use, see
matlabroot/toolbox/coder/compile/tmf/
grt_vcx64.tmf.
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Token Expansion
|>MODELREF_TARGET_TYPE<| Type of target being built. Possible values are

• NONE: Standalone model or top model referencing other
models

• RTW: Model reference target build
• SIM: Model reference simulation target build

|>RELATIVE_PATH_TO_ANCHOR<| Relative path, from the location of the generated makefile, to
the MATLAB working folder.

|>START_DIR<| Code generation folder at the time the build started. This
token is required for parallel builds.

These tokens are expanded by substitution of parameter values known to the build process. For
example, if the source model contains blocks with two different sample times, the TMF statement

NUMST = |>NUMST<|

expands to:

NUMST = 2

In addition to the above, make_rtw expands tokens from other sources:

• Target-specific tokens defined in the target options of the Configuration Parameters dialog box
• Structures in the rtwoptions section of the system target file. Structures in the rtwoptions

structure array that contain the field makevariable are expanded.

The following example is extracted from matlabroot/rtw/c/grt/grt.tlc. The section starting
with BEGIN_RTW_OPTIONS contains MATLAB code that sets up rtwoptions. The following directive
causes the |>EXT_MODE<| token to be expanded to 1 (on) or 0 (off), depending on how you set the
external mode options.

rtwoptions(2).makevariable = 'EXT_MODE'

Invoke the make Utility
• “make Command” on page 86-48
• “make Utility Versions” on page 86-49

make Command

After creating model_or_sharedutils.mk from your TMF, the build process invokes a make
command. To invoke make, the build process issues this command.

makecommand -f model_or_sharedutils.mk

makecommand is defined by the MAKECMD macro in your system target file TMF (see “Structure of the
Template Makefile” on page 86-49). You can specify additional options to make by using the model
configuration parameter Make command. (See the sections “Specify a Make Command” and
“Template Makefiles and Make Options”.)

For example, specifying OPT_OPTS=-O2 in the Make command field causes make_rtw to generate
the following make command.
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makecommand -f model_or_sharedutils.mk OPT_OPTS=-O2

A comment at the top of the TMF specifies the available make command options. If these options do
not provide you with enough flexibility, you can configure your own TMF.

make Utility Versions

The make utility lets you control nearly every aspect of building your real-time program. There are
several different versions of make available. The code generator provides the Free Software
Foundation GNU make for both UNIX9 and PC platforms in platform-specific subfolders under

matlabroot/bin

It is possible to use other versions of make with the code generator, although GNU Make is
recommended. To be compatible with the code generator, verify that your version of make supports
the following command format.

makecommand -f model_or_sharedutils.mk

Structure of the Template Makefile
A TMF has multiple sections, including the following:

• Abstract — Describes what the makefile targets. Here is a representative abstract from the ERT
TMFs in matlabroot/toolbox/coder/compile/tmf:
# Abstract:
#       Template makefile for building a Windows-based stand-alone embedded
#       real-time version of Simulink model using generated C code and the
#          Microsoft Visual C/C++ compiler for x64.
#
#       Note that this template is automatically customized by the build 
#       procedure to create "<model>.mk"
#
#       The following defines can be used to modify the behavior of the
#       build:
#         OPT_OPTS       - Optimization option. See DEFAULT_OPT_OPTS in
#                          vctools.mak for default.
#         OPTS           - User specific options.
#         CPP_OPTS       - C++ compiler options.
#         USER_SRCS      - Additional user sources, such as files needed by
#                          S-functions.
#         USER_INCLUDES  - Additional include paths
#                          (i.e. USER_INCLUDES="-Iwhere-ever -Iwhere-ever2")
#
#       To enable debugging:
#         set DEBUG_BUILD = 1, which will trigger OPTS=-Zi (may vary with
#                               compiler version, see compiler doc) 
#
#       This template makefile is designed to be used with a system target
#       file that contains 'rtwgensettings.BuildDirSuffix' see ert.tlc

• Macros read by make_rtw section — Defines macros that tell make_rtw how to process the
TMF. Here is a representative Macros read by make_rtw section from the GRT TMFs in
matlabroot/toolbox/coder/compile/tmf:
#------------------------ Macros read by make_rtw -----------------------------
#
# The following macros are read by the build procedure:
#
#  MAKECMD         - This is the command used to invoke the make utility
#  HOST            - What platform this template makefile is targeted for

9. UNIX is a registered trademark of The Open Group in the United States and other countries.
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#                    (i.e. PC or UNIX)
#  BUILD           - Invoke make from the build procedure (yes/no)?
#  SYS_TARGET_FILE - Name of system target file.

MAKECMD         = nmake
HOST            = PC
BUILD           = yes
SYS_TARGET_FILE = any
BUILD_SUCCESS    = ^#^#^# Created

# Opt in to simplified format by specifying compatible Toolchain
TOOLCHAIN_NAME = [\
    "Microsoft Visual C++ 2019 v16.0 | nmake (64-bit Windows)", \
    "Microsoft Visual C++ 2017 v15.0 | nmake (64-bit Windows)", \
    "Microsoft Visual C++ 2015 v14.0 | nmake (64-bit Windows)"]

The macros in this section might include:

• MAKECMD — Specifies the command used to invoke the make utility. For example, if MAKECMD =
mymake, then the make command invoked is

mymake -f model_or_sharedutils.mk
• HOST — Specifies the platform targeted by this TMF. This can be PC, UNIX, computer_name

(see the MATLAB computer command), or ANY.
• BUILD — Instructs make_rtw whether or not it should invoke make from the build procedure.

Specify yes or no.
• SYS_TARGET_FILE — Specifies the name of the system target file or the value any. This is

used for consistency checking by make_rtw to verify the system target file specified in the
Target selection panel of the Code Generation pane of the Configuration Parameters dialog
box. If you specify any, you can use the TMF with any system target file.

• BUILD_SUCCESS — When the makefile creates a static library, it produces the
BUILD_SUCCESS string as defined, for example, by this rule in ert_vcx64.tmf:
$(PRODUCT) : $(OBJS) $(LIBS) $(MODELREF_LINK_LIBS)
    @cmd /C "echo ### Linking ..."
    $(LD) $(LDFLAGS) $(LIBS) \
    @$(CMD_FILE) @$(MODELREF_LINK_RSPFILE) -dll -def:$(MODEL).def -out:$@
    @cmd /C "echo $(BUILD_SUCCESS) dynamically linked library  $(PRODUCT)"

When the build process finds the BUILD_SUCCESS string, it polls for the existence of the
updated static library file. The build process does not link the library file to the executable file
until the build process can confirm the presence of the library file, with an updated timestamp,
on the file system.

If the build process does not find BUILD_SUCCESS in the compilation log, then the build
process assumes that the updated library archive is available on the file system. If required,
the build process links the library to the executable file.

• Tokens expanded by make_rtw section — Defines the tokens that make_rtw expands. Here is
a brief excerpt from a representative Tokens expanded by make_rtw section from the ERT
TMFs in matlabroot/toolbox/coder/compile/tmf/:
#---------------------- Tokens expanded by make_rtw ----------------------------
#
# The following tokens, when wrapped with "|>" and "<|" are expanded by the
# build procedure.
#
#  MODEL_NAME          - Name of the Simulink block diagram
#  MODEL_MODULES       - Any additional generated source modules
#  MAKEFILE_NAME       - Name of makefile created from template makefile <model>.mk
#  MATLAB_ROOT         - Path to where MATLAB is installed.
...
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MODEL                   = |>MODEL_NAME<|
MODULES                 = |>MODEL_MODULES<|
PRODUCT                 = |>PRODUCT<|
MAKEFILE                = |>MAKEFILE_NAME<|
MATLAB_ROOT             = |>MATLAB_ROOT<|
...

For more information about TMF tokens, see Template Makefile Tokens Expanded by make_rtw.
• Subsequent sections vary based on compiler, host, and target. Some common sections include

Model and reference models, External mode, Tool Specifications or Tool
Definitions, Include Path, C Flags, Additional Libraries, and Source Files.

• Rules section — Contains the make rules used in building an executable from the generated
source code. The build rules are typically specific to your version of make. The Rules section
might be followed by related sections such as Dependencies.

Customize and Create Template Makefiles
• “Introduction” on page 86-51
• “Setting Up a Template Makefile” on page 86-51
• “Using Macros and Pattern Matching Expressions in a Template Makefile” on page 86-52
• “Customizing Generated Makefiles with rtwmakecfg” on page 86-53
• “Supporting Continuous Time in Custom Targets” on page 86-53
• “Model Reference Considerations” on page 86-54
• “Timeout Error When Building Shared Utility Code with Custom Template Makefile”

on page 86-54

Introduction

This section describes the mechanics of setting up a custom template makefile (TMF) and
incorporating it into the build process. It also discusses techniques for modifying a TMF and MATLAB
file mechanisms associated with the TMF.

Before creating a custom TMF, you should read “Folder and File Naming Conventions” on page 86-5
to understand the folder structure and MATLAB path requirements for custom targets.

Setting Up a Template Makefile

To customize or create a new TMF, copy an existing GRT or ERT TMF from matlabroot/toolbox/
coder/compile/tmf.

Place the copy in the same folder as the associated system target file. Usually, this is the mytarget/
mytarget folder within the target folder structure. Then, rename your TMF (for example,
mytarget.tmf) and modify it.

To allow the build process to locate and select your TMF, you must provide information in the system
target file file header (see “System Target File Structure” on page 86-18). For a target that
implements a single TMF, the standard way to specify the TMF to be used in the build process is to
use the TMF directive of the system target file file header.

TMF: mytarget.tmf
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Using Macros and Pattern Matching Expressions in a Template Makefile

This section shows, through an example, how to use macros and file-pattern-matching expressions in
a TMF to generate commands in model_or_sharedutils.mk.

The make utility processes model_or_sharedutils.mk and generates a set of commands based
upon dependency rules defined in model_or_sharedutils.mk. After make generates the set of
commands for building or rebuilding test, make executes them.

For example, to build a program called test, make must link the object files. However, if the object
files don't exist or are out of date, make must compile the source code. Thus there is a dependency
between source and object files.

Each version of make differs slightly in its features and how rules are defined. For example, consider
a program called test that gets created from two sources, file1.c and file2.c. Using most
versions of make, the dependency rules would be

test: file1.o file2.o
        cc -o test file1.o file2.o

file1.o: file1.c
        cc -c file1.c

file2.o: file2.c
        cc -c file2.c

In this example, a UNIX10 environment is assumed. In a PC environment the file extensions and
compile and link commands are different.

In processing the first rule

test: file1.o file2.o

make sees that to build test, it needs to build file1.o and file2.o. To build file1.o, make
processes the rule

file1.o: file1.c

If file1.o doesn't exist, or if file1.o is older than file1.c, make compiles file1.c.

The format of TMFs follows the above example. Our TMFs use additional features of make such as
macros and file-pattern-matching expressions. In most versions of make, a macro is defined with

MACRO_NAME = value

References to macros are made with $(MACRO_NAME). When make sees this form of expression, it
substitutes value for $(MACRO_NAME).

You can use pattern matching expressions to make the dependency rules more general. For example,
using GNU11 Make, you could replace the two “file1.o: file1.c” and “file2.o: file2.c”
rules with the single rule

%.o : %.c
        cc -c $<

10. UNIX is a registered trademark of The Open Group in the United States and other countries.
11. GNU is a registered trademark of the Free Software Foundation.
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Note that $< in the previous example is a special macro that equates to the dependency file (that is,
file1.c or file2.c). Thus, using macros and the "%" pattern matching character, the previous
example can be reduced to

SRCS = file1.c file2.c
OBJS = $(SRCS:.c=.o)

test: $(OBJS)
        cc -o $@ $(OBJS)

%.o : %.c
        cc -c $<

Note that the $@ macro above is another special macro that equates to the name of the current
dependency target, in this case test.

This example generates the list of objects (OBJS) from the list of sources (SRCS) by using the text
substitution feature for macro expansion. It replaces the source file extension (for example, .c) with
the object file extension (.o). This example also generalized the build rule for the program, test, to
use the special "$@" macro.

Customizing Generated Makefiles with rtwmakecfg

TMFs provide tokens that let you add the following items to generated makefiles:

• Source folders
• Include folders
• Run-time library names
• Run-time module objects

S-functions can add this information to the makefile by using an rtwmakecfg.m file function. This
function is particularly useful when building a model that contains one or more of your S-Function
blocks, such as device driver blocks.

To add information pertaining to an S-function to the makefile,

1 Create the function rtwmakecfg in file rtwmakecfg.m. The code generator associates this file
with your S-function based on its folder location.

2 Modify your target's TMF such that it supports macro expansion for the information returned by
rtwmakecfg functions.

After the TLC phase of the build process, when generating a makefile from the TMF, the build process
searches for an rtwmakecfg.m file in the folder that contains the S-function component. If it finds
the file, the build process calls the rtwmakecfg function. For more information, see “Use
rtwmakecfg.m API to Customize Generated Makefiles”.

Supporting Continuous Time in Custom Targets

If you want your custom ERT-based target to support continuous time, you must update your template
makefile (TMF) and the static main program module (for example, mytarget_main.c) for your
target.
Template Makefile Modifications

Add the NCSTATES token expansion after the NUMST token expansion, as follows:
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NUMST = |>NUMST<|
NCSTATES = |>NCSTATES<|

In addition, add NCSTATES to the CPP_REQ_DEFINES macro, as in the following example:
CPP_REQ_DEFINES = -DMODEL=$(MODEL) -DNUMST=$(NUMST) -DNCSTATES=$(NCSTATES) \
-DMAT_FILE=$(MAT_FILE)
-DINTEGER_CODE=$(INTEGER_CODE) \
-DONESTEPFCN=$(ONESTEPFCN) -DTERMFCN=$(TERMFCN) \
-DHAVESTDIO
-DMULTI_INSTANCE_CODE=$(MULTI_INSTANCE_CODE) \

Modifications to Main Program Module

The main program module defines a static main function that manages task scheduling for the
supported tasking modes of single- and multiple-rate models. NUMST (the number of sample times in
the model) determines whether the main function calls multirate or single-rate code. However, when
a model uses continuous time, do not rely on NUMST directly.

When the model has continuous time and the flag TID01EQ is true, both continuous time and the
fastest discrete time are treated as one rate in generated code. The code associated with the fastest
discrete rate is guarded by a major time step check. When the model has only two rates, and
TID01EQ is true, the generated code has a single-rate call interface.

To support models that have continuous time, update the static main module to take TID01EQ into
account, as follows:

1 Before NUMST is referenced in the file, add the following code:

#if defined(TID01EQ) && TID01EQ == 1 && NCSTATES == 0
#define DISC_NUMST (NUMST - 1)
#else
#define DISC_NUMST NUMST
#endif

2 Replace instances of NUMST in the file by DISC_NUMST.

Model Reference Considerations

See “Support Model Referencing” on page 86-60 for important information on TMF modifications
you may need to make to support the code generator model referencing features.

Note If you are using a TMF without the variable MODELREFS, the file might have been used with a
previous release of Simulink software. If you want your TMF to support model referencing, add
MODELREFS to the make file.

Timeout Error When Building Shared Utility Code with Custom Template Makefile

If the build process uses a custom template makefile to create a makefile for the shared utility code,
the build process produces a timeout error when all of these conditions apply:

• The configuration parameter GenCodeOnly is 'off'.
• The BUILD_SUCCESS message is output during the make call to rtwshared.mk.
• The make call to rtwshared.mk does not update the final product (typically rtwshared.lib).

To avoid the error, update the custom template makefile so that the make call generates the
BUILD_SUCCESS message only when the final product is generated (as identified by the make
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variable PRODUCT). Alternatively, if the build process does not use the generated makefile, disable
makefile generation by setting the configuration parameter GenerateMakefile to 'off'.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
• “Custom Target Optional Features”
• “Support Toolchain Approach with Custom Target”
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Custom Target Optional Features
This section describes how to configure a custom embedded target to support these optional features.

To ... Use Target Configuration
Parameters ...

For more information, see ...

Indicate a custom target is
toolchain-compliant

UseToolchainInfoCompliant
GenerateMakefile

“Support Toolchain Approach
with Custom Target”

Build a model that includes
referenced models and uses a
custom target

ModelReferenceCompliant
ParMdlRefBuildCompliant
(parallel build support)

“Support Model Referencing”

Control the compiler
optimization level building
generated code for a custom
target

CompOptLevelCompliant “Support Compiler Optimization
Level Control”

Control C function prototypes
of initialize and step functions
that are generated for a model
that uses a custom target

ModelStepFunctionPrototyp
eControlCompliant (ERT only)

“Support C Function Prototype
Control”

Control C++ class interfaces
that are generated for a model
that uses a custom target

CPPClassGenCompliant (ERT
only)

“Support C++ Class Interface
Control”

Enable concurrent execution
of multiple tasks on a
multicore platform for a
model that uses a custom
target

ConcurrentExecutionCompli
ant

“Support Concurrent Execution
of Multiple Tasks”

The required configuration changes are modifications to your system target file, and in some cases
also modifications to your template makefile (TMF) or your custom static main program.

The API for system target file callbacks provides a function SelectCallback for use in system
target files. SelectCallback is associated with the target rather than with its individual options. If
you implement a SelectCallback function for a target, it is triggered whenever the user selects the
target in the System Target File Browser.

The API provides the functions slConfigUIGetVal, slConfigUISetEnabled, and
slConfigUISetVal for controlling custom target configuration options from a user-written
SelectCallback function. (For function descriptions and examples, see the function reference
pages.)

The general requirements for supporting one of the optional features include:

• To support model referencing or compiler optimization level control, the target must be derived
from the GRT or the ERT target. To support C function prototype control or C++ class interface
control, the target must be derived from the ERT target.

• The system target file must declare feature compliance by including one of the target
configuration parameters listed above in a SelectCallback function call.
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• Additional changes such as TMF modifications or static main program modifications may be
required, depending on the feature. See the detailed steps in the subsections for individual
features.

For an example that shows how to configure custom target optional features, see “Customize System
Target Files”.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Support Toolchain Approach with Custom Target”
• “Support Model Referencing”
• “Support Compiler Optimization Level Control”
• “Support C Function Prototype Control”
• “Support C++ Class Interface Control”
• “Support Concurrent Execution of Multiple Tasks”
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Support Toolchain Approach with Custom Target
This section describes how to configure a custom system target file to support builds with the
toolchain approach.

In the Configuration Parameters dialog box, on the Code Generation pane of, you can set the build
controls for the toolchain approach or the template makefile approach. The model configuration
parameters that contribute to determining which build controls appear include these parameters.

Model Parameter Value Notes
UseToolchainInfoCompliant on For toolchain approach, set this

parameter to 'on'. For TMF approach,
set this parameter to 'off'.

GenerateMakefile on For toolchain approach, set this
parameter to 'on'.

When the dialog box detects that the selected target has these properties, the dialog box recognizes
the target as toolchain-compliant and displays the build controls for the toolchain approach.

Because the custom target file cannot set these properties directly, use a SelectCallback function
in the custom target file to set the properties. The SelectCallback function call in the
RTW_OPTION section of the TLC file can take the form:
rtwgensettings.SelectCallback = 'enableToolchainCompliant(hSrc, hDlg)';

A corresponding callback function can contain:
function enableToolchainCompliant(hSrc, hDlg)
  % The following parameters enable toolchain compliance.
  slConfigUISetVal(hDlg, hSrc, 'UseToolchainInfoCompliant', 'on');
  slConfigUISetVal(hDlg, hSrc, 'GenerateMakefile','on');
  
  % The following parameters are not required for toolchain compliance.
  % But, it is recommended practice to set these default values and 
  % disable the parameters (as shown).
  slConfigUISetVal(hDlg, hSrc, 'RTWCompilerOptimization','off');
  slConfigUISetVal(hDlg, hSrc, 'MakeCommand','make_rtw');
  slConfigUISetEnabled(hDlg, hSrc, 'RTWCompilerOptimization',false);
  slConfigUISetEnabled(hDlg, hSrc, 'MakeCommand',false);
  hSrc.refreshDialog;
end

When you select your custom target, the configuration parameters dialog box displays the toolchain
approach build controls. For an example, see “Create a Custom Target Configuration” on page 86-32.

For an example that shows how to configure custom target optional features, see “Customize System
Target Files”.

See Also

More About
• “Customize System Target Files”
• “Support Model Referencing”
• “Support Compiler Optimization Level Control”
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• “Support C Function Prototype Control”
• “Support C++ Class Interface Control”
• “Support Concurrent Execution of Multiple Tasks”
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Support Model Referencing
If you want to use a custom system target file for building a model that has referenced models, you
must configure the custom system target file to support model referencing.

Requirements for Model Referencing with a Custom System Target
File
To build a model that references other models:

• Use a custom system target file that is derived from a GRT or ERT system target file.
• The custom system target file must declare model reference compliance –– see “Declaring Model

Referencing Compliance” on page 86-60.
• The template makefile must define some entities that support model referencing –– see “Providing

Model Referencing Support in the TMF” on page 86-60.

Declaring Model Referencing Compliance
To declare model reference compliance for your target, you must implement a callback function that
sets the ModelReferenceCompliant flag, and then install the callback function in the
SelectCallback field of the rtwgensettings structure in your system target file. The callback
function is triggered whenever the user selects the target in the System Target File Browser. For
example, the following system target file code installs a SelectCallback function named
custom_select_callback_handler:
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by
the callback API functions. These handles are restricted to use in system target file callback
functions. They should be passed in without alteration.

Your callback function should set the ModelReferenceCompliant flag as follows:
slConfigUISetVal(hDlg,hSrc,'ModelReferenceCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'ModelReferenceCompliant',false);
hSrc.refreshDialog;

If you might use the target to build models containing large model reference hierarchies, consider
configuring the target to support parallel builds, as discussed in “Reduce Build Time for Referenced
Models by Using Parallel Builds”.

To configure a target for parallel builds, your callback function must also set the
ParMdlRefBuildCompliant flag as follows:
slConfigUISetVal(hDlg,hSrc,'ParMdlRefBuildCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'ParMdlRefBuildCompliant',false);
hSrc.refreshDialog;

For more information about the system target file callback API, see the slConfigUIGetVal,
slConfigUISetEnabled, and slConfigUISetVal function reference pages.

Providing Model Referencing Support in the TMF
To configure the template makefile (TMF) for model referencing:
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1 Add the following make variables and tokens to be expanded when the makefile is generated:
MODELREFS                 = |>MODELREFS<|
MODELLIB                  = |>MODELLIB<|
MODELREF_LINK_LIBS        = |>MODELREF_LINK_LIBS<|
MODELREF_LINK_RSPFILE     = |>MODELREF_LINK_RSPFILE_NAME<|
RELATIVE_PATH_TO_ANCHOR   = |>RELATIVE_PATH_TO_ANCHOR<|
MODELREF_TARGET_TYPE      = |>MODELREF_TARGET_TYPE<|

The following code excerpt shows how makefile tokens are expanded for a referenced model.
MODELREFS                 =
MODELLIB                  = engine3200cc_rtwlib.a
MODELREF_LINK_LIBS        =
MODELREF_LINK_RSPFILE     =
RELATIVE_PATH_TO_ANCHOR   = ../../..
MODELREF_TARGET_TYPE      = RTW

The following code excerpt shows how makefile tokens are expanded for the top model that
references the referenced model.
MODELREFS                 = engine3200cc transmission
MODELLIB                  = 
MODELREF_LINK_LIBS        = engine3200cc_rtwlib.a transmission_rtwlib.a
MODELREF_LINK_RSPFILE     =
RELATIVE_PATH_TO_ANCHOR   = ..
MODELREF_TARGET_TYPE      = NONE

Token Expands to
MODELREFS for the top model List of referenced model names.
MODELLIB Name of the library generated for the model.
MODELREF_LINK_LIBS token for the top
model

List of referenced model libraries that the top
model links against.

MODELREF_LINK_RSPFILE token for the
top model

Name of a response file that the top model links
against. This token is valid only for build
environments that support linker response files.
For an example of its use, see matlabroot/
toolbox/coder/compile/tmf/
grt_vcx64.tmf.

RELATIVE_PATH_TO_ANCHOR Relative path, from the location of the generated
makefile, to the MATLAB working folder.

MODELREF_TARGET_TYPE Signifies the type of target being built. Possible
values are

• NONE: Standalone model or top model
referencing other models

• RTW: Model reference target build
• SIM: Model reference simulation target build

If you are configuring your target to support parallel builds, as discussed in “Reduce Build Time
for Referenced Models by Using Parallel Builds”, you must also add the following token
definitions to your TMF:

START_DIR = |>START_DIR<|
MASTER_ANCHOR_DIR = |>MASTER_ANCHOR_DIR<|

 Support Model Referencing

86-61



Token Expands to
START_DIR Current work folder (pwd) at the time the

build started.
MASTER_ANCHOR_DIR Current work folder (pwd) at the time the

build started.
2 Add the RELATIVE_PATH_TO_ANCHOR include path to the overall INCLUDES variable.

INCLUDES = -I. -I$(RELATIVE_PATH_TO_ANCHOR) $(ADD_INCLUDES) \
       $(USER_INCLUDES) $(SHARED_INCLUDES)

3 Change the SRCS variable in your TMF so that it initially lists only common modules. Additional
modules are then appended conditionally, as described in the next step. For example, change
SRCS  = $(MODEL).c $(MODULES) ert_main.c $(ADD_SRCS) $(EXT_SRC)

to

SRCS = $(MODULES)
4 Create variables to define the final target of the makefile. You can remove variables that may

have existed for defining the final target. For example, remove

PROGRAM   = ../$(MODEL)

and replace it with
ifeq ($(MODELREF_TARGET_TYPE), NONE)
  # Top model for RTW
  PRODUCT            = $(RELATIVE_PATH_TO_ANCHOR)/$(MODEL)
  BIN_SETTING        = $(LD) $(LDFLAGS) -o $(PRODUCT) $(SYSLIBS)
  BUILD_PRODUCT_TYPE = "executable"
  # ERT based targets
  SRCS               += $(MODEL).c ert_main.c $(EXT_SRC)
  # GRT based targets
  # SRCS             += $(MODEL).c grt_main.c rt_sim.c $(EXT_SRC) $(SOLVER)

else
  # sub-model for RTW
  PRODUCT            = $(MODELLIB)
  BUILD_PRODUCT_TYPE = "library"
endif

Note If the template makefile is associated with a toolchain, remove $(MODEL).c or $
(MODEL).$(TARGET_LANG_EXT) from the SRCS list.

5 Create rules for the final target of the makefile (replace existing final target rules). For example:
ifeq ($(MODELREF_TARGET_TYPE),NONE)
  # Top model for RTW
  $(PRODUCT) : $(OBJS) $(LIBS) $(MODELREF_LINK_LIBS)
               $(BIN_SETTING) $(LINK_OBJS) $(MODELREF_LINK_LIBS)
               $(LIBS)
               @echo "### Created $(BUILD_PRODUCT_TYPE): $@"
else
  # sub-model for RTW
  $(PRODUCT) : $(OBJS) $(LIBS)
               @rm -f $(MODELLIB)
               $(ar) ruvs $(MODELLIB) $(LINK_OBJS)
               @echo "### Created $(MODELLIB)"
               @echo "### Created $(BUILD_PRODUCT_TYPE): $@"
endif

6 Create a rule to allow referenced models to compile files that reside in the MATLAB working
folder (pwd).
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%.o : $(RELATIVE_PATH_TO_ANCHOR)/%.c
    $(CC) -c $(CFLAGS) $<

Note If you are using a TMF without the variable MODELREFS, the file might have been used with a
previous release of Simulink software. If you want your TMF to support model referencing, add either
variable MODELREFS to the make file.

Controlling Configuration Option Value Agreement
By default, the value of a configuration option defined in the system target file for a TLC-based
custom target must be the same in a referenced model and its parent model. To relax this
requirement, include the modelReferenceParameterCheck field in the rtwoptions structure
element that defines the configuration option, and set the value of the field to 'off'. For example:
rtwoptions(2).prompt         = 'My Custom Parameter';
rtwoptions(2).type           = 'Checkbox';
rtwoptions(2).default        = 'on';
rtwoptions(2).modelReferenceParameterCheck  = 'on';
rtwoptions(2).tlcvariable    = 'mytlcvariable';
...

The configuration option My Custom Parameter can differ in a referenced model and its parent
model. See “Customize System Target Files” on page 86-18 for information about TLC-based system
target files, and rtwoptions Structure Fields Summary for a list of rtwoptions fields.

Preventing Resource Conflicts (Optional)
Hook files are optional TLC and MATLAB program files that are invoked at well-defined stages of the
build process. Hook files let you customize the build process and communicate information between
various phases of the process.

If you are adapting your custom target for code generation compatibility with model reference
features, consider adding checks to your hook files for handling referenced models differently than
top models to prevent resource conflicts.

For example, consider adding the following check to your STF_make_rtw_hook.m file:
% Check if this is a referenced model
mdlRefTargetType = get_param(codeGenModelName,`ModelReferenceTargetType');
isNotModelRefTarget = strcmp(mdlRefTargetType, `NONE'); % NONE, SIM, or RTW
if isNotModelRefTarget
  % code that is specific to the top model
else
  % code that is specific to the referenced model
end

You may need to do a similar check in your TLC code.

%if !IsModelReferenceTarget()
  %% code that is specific to the top model
%else
  %% code that is specific to the referenced model
%endif
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See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
• “Model Reference Basics”
• “Generate Code for Model Reference Hierarchy”
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Support Compiler Optimization Level Control
This section describes how to configure a custom embedded target to support compiler optimization
level control. Without the described modifications, you cannot use model configuration parameter
Compiler optimization level to control the compiler optimization level for building generated code.
For more information about compiler optimization level control, see “Compiler optimization level”.

About Compiler Optimization Level Control and Custom Targets
The requirements for supporting compiler optimization level control are as follows:

• The target must be derived from the GRT target or the ERT target.
• The system target file must declare compiler optimization level control compliance, as described

in “Declaring Compiler Optimization Level Control Compliance” on page 86-65.
• The target makefile must honor the setting for model configuration parameter Compiler

optimization level, as described in “Providing Compiler Optimization Level Control Support in
the Target Makefile” on page 86-66.

For an example that shows how to configure custom target optional features, see “Customize System
Target Files”.

Declaring Compiler Optimization Level Control Compliance
To declare compiler optimization level control compliance for your target, you must implement a
callback function that sets the CompOptLevelCompliant flag, and then install the callback function
in the SelectCallback field of the rtwgensettings structure in your system target file. The
callback function is triggered whenever the user selects the target in the System Target File Browser.
For example, the following system target file code installs a SelectCallback function named
custom_select_callback_handler:
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by
the callback API functions. These handles are restricted to use in system target file callback
functions. They should be passed in without alteration.

Your callback function should set the CompOptLevelCompliant flag as follows:
slConfigUISetVal(hDlg,hSrc,'CompOptLevelCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'CompOptLevelCompliant',false);
hSrc.refreshDialog;

For more information about the system target file callback API, see the slConfigUIGetVal,
slConfigUISetEnabled, and slConfigUISetVal function reference pages.

When the CompOptLevelCompliant target configuration parameter is set to on, the Compiler
optimization level parameter is displayed in the Code Generation pane of the Configuration
Parameters dialog box for your model.
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Providing Compiler Optimization Level Control Support in the Target
Makefile
As part of supporting compiler optimization level control for your target, you must modify the target
makefile to honor the setting for model configuration parameter Compiler optimization level. Use a
GRT or ERT target provided by MathWorks as a model for making the modifications.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
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Support C Function Prototype Control
This section describes how to configure a custom embedded target to support function prototype
control. Without the described modifications, you will not be able to use available interfaces for
customizing entry-point function interfaces. For more information, see “Configure C Code Generation
for Model Entry-Point Functions” on page 33-112.

About C Function Prototype Control and Custom Targets
The requirements for supporting C function prototype control are as follows:

• The system target file must be derived from the ERT system target file.
• The system target file must declare C function prototype control compliance, as described in

“Declaring C Function Prototype Control Compliance” on page 86-67.
• If your system target file uses a custom static main program, and if a nondefault function

prototype control configuration is associated with a model, the static main program must call the
function prototype controlled initialize and step functions, as described in “Providing C Function
Prototype Control Support in the Custom Static Main Program” on page 86-68.

For an example that shows how to configure custom target optional features, see “Customize System
Target Files”.

Declaring C Function Prototype Control Compliance
To declare C function prototype control compliance for your target, you must implement a callback
function that sets the ModelStepFunctionPrototypeControlCompliant flag, and then install the
callback function in the SelectCallback field of the rtwgensettings structure in your system
target file. The callback function is triggered whenever the user selects the target in the System
Target File Browser. For example, the following system target file code installs a SelectCallback
function named custom_select_callback_handler:

rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by
the callback API functions. These handles are restricted to use in system target file callback
functions. They should be passed in without alteration.

Your callback function should set the ModelStepFunctionPrototypeControlCompliant flag as
follows:

slConfigUISetVal(hDlg,hSrc,'ModelStepFunctionPrototypeControlCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'ModelStepFunctionPrototypeControlCompliant',false);
hSrc.refreshDialog;

For more information about the system target file callback API, see the slConfigUIGetVal,
slConfigUISetEnabled, and slConfigUISetVal function reference pages.

When the ModelStepFunctionPrototypeControlCompliant target configuration parameter is
set to on, you can use the Configure C Step Function Interface dialog box to control the function
prototype of the base-rate step function generated for a rate-based model.
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Providing C Function Prototype Control Support in the Custom Static
Main Program
If your target uses a custom static main program, and if a nondefault function prototype control
configuration is associated with a model, you must update the static main program to call the
function prototype controlled initialize and step functions. You can do this in either of the following
ways:

1 Manually adapt your static main program to declare model data and call the function prototype
controlled initialize and step functions.

2 Generate your main program by selecting model configuration parameter Generate an example
main program. The generated main program declares model data and calls the function
prototype controlled initialize and step function.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
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Support C++ Class Interface Control
This section describes how to configure a custom embedded target to support C++ class interface
control. Without the described modifications, you will not be able to use C++ class code interface
packaging to generate and configure C++ class interfaces to model code. For more information about
C++ class interface control, see “Interactively Configure C++ Interface” on page 42-2.

About C++ Class Interface Control and Custom Targets
The requirements for supporting C++ class interface control are as follows:

• The target must be derived from the ERT system target file.
• The system target file must declare C++ class interface control compliance, as described in

“Declaring C++ Class Interface Control Compliance” on page 86-69.

For an example that shows how to configure custom target optional features, see “Customize System
Target Files”.

Declaring C++ Class Interface Control Compliance
To declare C++ class interface control compliance for your target, you must implement a callback
function that sets the CPPClassGenCompliant flag, and then install the callback function in the
SelectCallback field of the rtwgensettings structure in your system target file. The callback
function is triggered whenever the user selects the target in the System Target File Browser. For
example, the following system target file code installs a SelectCallback function named
custom_select_callback_handler:
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by
the callback API functions. These handles are restricted to use in system target file callback
functions. They should be passed in without alteration.

Your callback function should set the CPPClassGenCompliant flag as follows:
slConfigUISetVal(hDlg,hSrc,'CPPClassGenCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'CPPClassGenCompliant',false);
hSrc.refreshDialog;

For more information about the system target file callback API, see the slConfigUIGetVal,
slConfigUISetEnabled, and slConfigUISetVal function reference pages.

When the CPPClassGenCompliant target configuration parameter is set to on, you can use the C++
class code interface packaging to generate and configure C++ class interfaces to model code.

Providing C++ Class Interface Control Support in the Custom Static
Main Program
Selecting C++ class code interface packaging for your model enables model configuration
parameter Generate an example main program. When you select this parameter,the code
generator produces an example main program, ert_main.cpp. The generated example main
program declares model data and calls the C++ class interface configured model step method, and
illustrates how the generated code can be deployed.
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To customize the build process and disable generation and inclusion of an example main program, see
the setTargetProvidesMain function. Disabling example main generation permits including a
custom main program.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
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Support Concurrent Execution of Multiple Tasks
If a custom embedded target must support concurrent execution of multiple tasks on a multicore
platform, the target must declare support for concurrent execution by setting the target configuration
option ConcurrentExecutionCompliant. Otherwise, you will not be able to configure a multicore
target model for concurrent execution.

If ConcurrentExecutionCompliant is not already configured for your custom target, you can set
the option in the following ways:

• Include the following code directly in your system target file (mytarget.tlc):
rtwgensettings.SelectCallback = 'slConfigUISetVal(hDlg,hSrc,...
     ''ConcurrentExecutionCompliant'',''on'');';
rtwgensettings.ActivateCallback = 'slConfigUISetVal(hDlg,hSrc,...
     ''ConcurrentExecutionCompliant'',''on'');';

• Implement a callback function that sets the ConcurrentExecutionCompliant option, and then
install the callback function in the SelectCallback field of the rtwgensettings structure in
your system target file. The callback function is triggered whenever the user selects the target in
the System Target File Browser. For example, the following system target file code installs a
SelectCallback function named custom_select_callback_handler:
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used
by the callback API functions. These handles are restricted to use in system target file callback
functions. They should be passed in without alteration.

Your callback function should set the ConcurrentExecutionCompliant option as follows:
slConfigUISetVal(hDlg,hSrc,'ConcurrentExecutionCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'ConcurrentExecutionCompliant',false);
hSrc.refreshDialog;

For more information about the system target file callback API, see the slConfigUIGetVal,
slConfigUISetEnabled, and slConfigUISetVal function reference pages.

When the ConcurrentExecutionCompliant target configuration option is set to 'on', you can
select the custom target and configure your multicore target model for concurrent execution.

For an example that shows how to configure custom target optional features, see “Customize System
Target Files”.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
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Device Drivers
Device drivers that communicate with target hardware are essential to many real-time development
projects.

You can integrate existing C (or C++) device driver functions into Simulink models by using the
Legacy Code Tool. When you use the code generator to generate code from a model, the Legacy Code
Tool can insert a call to your C function into the generated code. For details, see “Import Calls to
External Code into Generated Code with Legacy Code Tool” and “Integrate C Functions into Simulink
Models with Legacy Code Tool”.

See Also

More About
• “Custom Targets”
• “Sample Custom Targets”
• “Customize System Target Files”
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Model Setup
In this section...
“Block Selection” on page 87-2
“Configure Target Hardware Resources” on page 87-2

Block Selection
You can create models for targeting the same way you create other Simulink models—by combining
standard blocks and C-MEX S-functions.

You can use blocks from the following sources:

• The Embedded Coder Support Packages.
• The Embedded Targets library (embeddedtargetslib) in the Embedded Coder product.
• Blocks from the System Toolboxes products
• Custom blocks

Avoid using blocks that do not generate code, including the following blocks.

Block Name/Category Library Description
Scope Simulink, DSP System

Toolbox software
Provides oscilloscope view of your output.
Do not use the Save data to workspace
option on the Data history pane in the
Scope Parameters dialog.

To Workspace Simulink Return data to your MATLAB workspace.
From Workspace Simulink Send data to your model from your

MATLAB workspace.
Spectrum Scope DSP System Toolbox Compute and display the short-time FFT of

a signal. It has internal buffering that can
slow your process without adding value.

To File Simulink Send data to a file on your host machine.
From File Simulink Get data from a file on your host machine.
Triggered to Workspace DSP System Toolbox Send data to your MATLAB workspace.
Signal To Workspace DSP System Toolbox Send a signal to your MATLAB workspace.
Signal From Workspace DSP System Toolbox Get a signal from your MATLAB workspace.
Triggered Signal From
Workspace

DSP System Toolbox Get a signal from your MATLAB workspace.

To Wave device DSP System Toolbox Send data to a .wav device.
From Wave device DSP System Toolbox Get data from a .wav device.

Configure Target Hardware Resources
To configure your Simulink model for your target hardware and toolchain:
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1 In the Configuration Parameters dialog box, select Hardware Implementation, and then specify
your Hardware board.

Specifying a Hardware board automatically sets many Code Generation parameters to values
appropriate for the hardware.

2 On the Target Hardware Resources tab, review the other parameters.
3 (Optional) In the Configuration Parameters dialog box, select Code Generation, and then review

and modify other code generation features for your model.
4 Click Apply, and save the changes to your model.

“Embedded Coder Supported Hardware”

 Model Setup
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Replace Code for Embedded Targets
In this section...
“Using a Processor-Specific Code Replacement Library to Optimize Code” on page 88-2
“Process of Determining Optimization Effects Using Real-Time Profiling Capability” on page 88-2

Using a Processor-Specific Code Replacement Library to Optimize
Code
You can optimize the code the code generator produces for a specific processor by configuring the
code generator to use a code replacement library (CRL) during code generation. If you have an
Embedded Coder license, you can develop and apply custom code replacement libraries.

For more information about replacing code, using code replacement libraries that MathWorks
provides, see “What Is Code Replacement?” on page 55-2 and “Replace Code Generated from
Simulink Models” on page 55-8. For information about developing code replacement libraries, see
“What Is Code Replacement Customization?” on page 67-3 and “Develop a Code Replacement
Library” on page 67-20.

Process of Determining Optimization Effects Using Real-Time Profiling
Capability
You can use the real-time profiling capability to examine the results of applying the processor-specific
library functions and operators to your generated code. After you select a processor-specific code
replacement library, use the real-time execution profiling capability to examine the change in
program execution time.

Use the following process to evaluate the effects of applying a processor-specific code replacement
library when you generate code:

1 Enable real-time profiling in your model. Refer to “Code Execution Profiling”.
2 Generate code for your project without specifying a code replacement library (the default Code

replacement library setting is None).
3 Profile the code, and save the report.
4 Rebuild your project using a processor-specific code replacement library.
5 Profile the code, and save the second report.
6 Compare the profile report from running your application with the processor-specific library

selected to the profile results in the first report with no code replacement library selected.

For an example of verifying the code optimization, search help for "Optimizing Embedded Code via
Code Replacement Library" and select the example that matches your IDE.
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Specify Comment Style for C/C++ Code
In this section...
“Specify Comment Style Using the MATLAB Coder App” on page 89-2
“Specify Comment Style Using the Command-Line Interface” on page 89-2

If you have an Embedded Coder, you can specify the comment style for C/C++ code generated from
MATLAB code. Specify single-line style to generate single-line comments preceded by //. Specify
multiline style to generate single-line or multiline comments delimited by /* and */. Single-line style
is the default for C++ code generation. Multiline style is the default for C code generation. For C
code generation, select single-line comment style only if your compiler supports it.

Specify Comment Style Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library (.lib)
• Dynamic Library (.dll)
• Executable (.exe)

3 Click More Settings.
4 On the Code Appearance tab, select the Include comments check box if it is not already

selected. By default, the Include comments check box is selected.
5 Set Comment Style to one of the following options.

Value Description
Auto(Use standard comment style of
the target language)

For C, generate multiline comments. For C++,
generate single-line comments. (default)

Single-line (Use C++-style
comments)

Generate single-line comments preceded
by //.

Multi-line (Use C-style comments) Generate single-line or multiline comments
delimited by /* and */.

Specify Comment Style Using the Command-Line Interface
1 Create a code configuration object for C/C++ code generation. For example, create a

configuration object for C/C++ static library generation:

cfg = coder.config('lib','ecoder',true);
2 Set the CommentStyle property to one of the following values:

Value Description
'Auto' For C, generate multiline comments. For C++, generate single-line

comments. (default)
'Single-line' Generate single-line comments preceded by //.
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Value Description
'Multi-line' Generate single-line or multiline comments delimited by /* and */.

For example, this code sets the comment style to single-line style:

cfg.CommentStyle='Single-line';

See Also
coder.EmbeddedCodeConfig

More About
• “Configure Build Settings”
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Specify Indent Style for C/C++ Code
In this section...
“Specify Indent Style Using the MATLAB Coder App” on page 89-4
“Specify Indent Style Using the Command-Line Interface” on page 89-5

If you have an Embedded Coder license, you can control the indent style and indent size in C/C++
code generated from MATLAB code. Indent style controls the placement of braces. Indent size
controls the number of characters per indentation level.

You can specify the K&R indent style or the Allman indent style. Both styles:

• Place the function opening and closing braces on their own lines at the same indentation level as
the function header.

• Indent code within the function according to the indent size.
• For blocks within a function, place closing braces on a new line at the same indentation level as

the control statement.
• Indent code within a block according to the indent size.

The K&R style and the Allman style differ in their placement of the opening brace for a control
statement. If you want the opening brace on the same line as its control statement, select the K&R
style. Here is code that has the K&R indent style:

void addone(const double x[6], double z[6])
{
  int i;
  for (i = 0; i < 6; i++) {
    z[i] = x[i] + 1.0;
  }
}

If you want the opening brace on its own line, select the Allman style. Here is code that has the
Allman indent style:

void addone(const double x[6], double z[6])
{
  int i;
  for (i = 0; i < 6; i++)
  {
    z[i] = x[i] + 1.0;
  }
}

Specify Indent Style Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library (.lib)
• Dynamic Library (.dll)
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• Executable (.exe)
3 Click More Settings.
4 On the All Settings tab, under Advanced, set Indent style to K&R or Allman.
5 On the All Settings tab, under Advanced, set Indent size to an integer from 2 to 8.

Specify Indent Style Using the Command-Line Interface
1 Create a code configuration object for 'lib', 'dll', or 'exe'. For example:

cfg = coder.config('lib','ecoder',true); % or dll or exe
2 Set the IndentStyle property to 'K&R' or 'Allman'. For example:

cfg.IndentStyle = 'Allman';
3 Set the IndentSize property to an integer from 2 to 8. For example:

cfg.IndentSize = 4;

See Also
coder.EmbeddedCodeConfig

More About
• “Configure Build Settings”
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Generate Custom File and Function Banners for C/C++ Code
When you generate C and C++ code from MATLAB code, you can use a code generation template
(CGT) file to specify custom:

• File banners
• Function Banners
• File trailers
• Comments before code sections

This example shows how you can create your own CGT file and customize it to generate your own file
and function banners.

1 Create a local copy of the default CGT file for MATLAB Coder and rename it. The default CGT file
is matlabcoder_default_template.cgt in the matlabroot/toolbox/coder/
matlabcoder/templates/ folder.

2 Store the copy in a folder that is outside of the MATLAB folder structure, but on the MATLAB
path. If necessary, add the folder to the MATLAB path. If you intend to use the CGT file with a
custom target, locate the CGT file in a folder under your target root folder. If the file is not on the
MATLAB path, specify a full path to the file when adding the file to your configuration.

3 View the default template and generated output. For example, here is the default File Banner
section:
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom File Banner section (optional)
%% Customize File banners by using either custom tokens or the following
%% predefined tokens: 
%% %<FileName>, %<MATLABCoderVersion>, %<EmbeddedCoderVersion>
%% %<SourceGeneratedOn>, %<HardwareSelection>, %<OutputType>
%%
%% You can also use "custom tokens" in all of the sections below. See the 
%% documentation center for more details. 
%%
<FileBanner style="classic">
File: %<FileName>

MATLAB Coder version           : %<MATLABCoderVersion>
C/C++ source code generated on : %<SourceGeneratedOn>
</FileBanner>

When you generate code using this default, the file banner looks similar to this file banner:
/*
 * File: coderand.c
 *
 * MATLAB Coder version            : 2.7
 * C/C++ source code generated on  : 06-Apr-2014 14:34:15
 */

4 Edit your local copy of the CGT file. You can change the default values and add your own custom
tokens. For example, here is the File Banner section with the style changed to box and a custom
token myCustomToken:
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom File Banner section (optional)
%% Customize File banners by using either custom tokens or the following
%% predefined tokens: 
%% %<FileName>, %<MATLABCoderVersion>, %<EmbeddedCoderVersion>
%% %<SourceGeneratedOn>, %<HardwareSelection>, %<OutputType>
%%
%% You can also use "custom tokens" in all of the sections below. See the 
%% documentation center for more details. 
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%%
<FileBanner style="box">
File: %<FileName>

My custom token                : %<myCustomToken>

MATLAB Coder version           : %<MATLABCoderVersion>
C/C++ source code generated on : %<SourceGeneratedOn>
</FileBanner>

For more information, see “Code Generation Template Files for MATLAB Code” on page 89-9.
5 Create a configuration object for generation of a C static library for an embedded target.

% Create configuration object for an embedded target
cfgObj = coder.config('lib','ecoder',true); 

6 Create a MATLABCodeTemplate object from your CGT file and add it to the configuration object.

% Specify the custom CGT file
CGTFile = 'myCGTFile.cgt';
% Use custom template
cfgObj.CodeTemplate = coder.MATLABCodeTemplate(CGTFile); 

7 Assign values for custom tokens that you added to the template. For example, assign the value
'myValue' to the myCustomToken token that you added in a previous step.

cfgObj.CodeTemplate.setTokenValue('myCustomToken','myValue');
8 Make sure that generation of comments is enabled. Otherwise, the code generator does not

produce file or function banners.

cfgObj.GenerateComments=true;
9 Generate code using the configuration object that you created.

codegen -config cfgObj coderand
10 View the changes to the generated file banner. For example, here is the file banner for

coderand.c using the customized CGT file:
/******************************************************************************/
/* File: coderand.c                                                           */
/*                                                                            */
/* My custom token                : myValue                                   */
/*                                                                            */
/* MATLAB Coder version           : 2.7                                       */
/* C/C++ source code generated on : 06-Apr-2014 14:42:55                      */
/******************************************************************************/

Changes to a CGT file do not affect the generated code unless you create a MATLABCodeTemplate
object from the modified CGT file, and then add it to the configuration object. If you modify the CGT
File, myCGTFile.cgt, used in the previous example, you must repeat these steps:

1 Create a MATLABCodeTemplate object from myCGTFile.cgt and add it to the configuration
object.

CGTFile = 'myCGTFile.cgt';
cfgObj.CodeTemplate = coder.MATLABCodeTemplate(CGTFile); 

2 Assign the value 'myValue' to the myCustomToken token.

cfgObj.CodeTemplate.setTokenValue('myCustomToken','myValue');
3 Generate code.

codegen -config cfgObj coderand

 Generate Custom File and Function Banners for C/C++ Code

89-7



See Also
coder.MATLABCodeTemplate

More About
• “Code Generation Template Files for MATLAB Code” on page 89-9
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Code Generation Template Files for MATLAB Code
In this section...
“Default CGT File” on page 89-9
“CGT File Structure” on page 89-9
“Components of the CGT File Sections” on page 89-10

A code generation template (CGT) file defines the sections in generated code that you can customize
using comments and tokens. Using a code generation template (CGT) file for the generation of C and
C++ code from MATLAB code, you can specify custom file banners and function banners for
generated code. File banners are comment sections in the header and trailer sections of a generated
file. Function banners are comment sections for each function in the generated code. You can also
customize comments before code sections. Use these banners to:

• Add a company copyright statement.
• Specify a special version symbol for your configuration management system.
• Remove timestamps.
• Add other custom information to your generated files.

For information on creating, customizing, and using a CGT file, see “Generate Custom File and
Function Banners for C/C++ Code” on page 89-6.

Default CGT File
You can base your custom template on the default CGT file,
matlabcoder_default_template.cgt, in the matlabroot/toolbox/coder/matlabcoder/
templates/ folder.

Note If you choose not to customize banners for your generated code, the default template is used
for code generation.

CGT File Structure
A CGT file consists of 13 optional sections.

File Banner Section

Contains comments and tokens for use in generating a custom file banner.

Function Banner Section

Contains comments and tokens for use in generating a custom function banner.

Shared Utility Function Banner

Contains comments and tokens for use in generating custom banners for shared utility functions.

File Trailer Section

Contains comments for use in generating a custom trailer banner.

 Code Generation Template Files for MATLAB Code

89-9



Include Files Banner

Contains comments for use in generating a custom banner for the include files section.

Type Definitions

Contains comments for use in generating a custom banner for the type definitions section.

Named Constants

Contains comments for use in generating a custom banner for the named constants section.

Variable Declarations

Contains comments for use in generating a custom banner for the variable declarations section.

Variable Definitions

Contains comments for use in generating a custom banner for the variable definitions section.

Function Declarations

Contains comments for use in generating a custom banner for the function declarations section.

Function Definitions

Contains comments for use in generating a custom banner for the function definitions section.

Custom Source Code

Contains comments for use in generating a custom banner for the custom source code section.

Custom Header Code

Contains comments for use in generating a custom banner for the custom header code section.

Components of the CGT File Sections
Each CGT file section is defined by open and close tags.

CGT File Section Open Tag Close Tag
“File Banner” on page 89-
13

<FileBanner> </FileBanner>

“Function Banner Section”
on page 89-9

<FunctionBanner> </FunctionBanner>

“Shared Utility Function
Banner” on page 89-9

<SharedUtilityBanner> </SharedUtilityBanner>

“File Trailer Section” on
page 89-9

<FileTrailer> </FileTrailer>

“Include Files Banner” on
page 89-10

<IncludeFilesBanner> </IncludeFilesBanner>
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CGT File Section Open Tag Close Tag
“Type Definitions” on page
89-10

<TypeDefinitionsBanner> </TypeDefinitionsBanner>

“Named Constants” on page
89-10

<NamedConstantsBanner> </NamedConstantsBanner>

“Variable Declarations” on
page 89-10

<VariableDeclarationsBanner> </VariableDeclarationsBanner>

“Variable Definitions” on
page 89-10

<VariableDefinitionsBanner> </VariableDefinitionsBanner>

“Function Declarations” on
page 89-10

<FunctionDeclarationsBanner> </FunctionDeclarationsBanner>

“Function Definitions” on
page 89-10

<FunctionDefinitionsBanner> </FunctionDefinitionsBanner>

“Custom Source Code” on
page 89-10

<CustomSourceCodeBanner> </CustomSourceCodeBanner>

“Custom Header Code” on
page 89-10

<CustomHeaderCodeBanner> </CustomHeaderCodeBanner>

You can customize your banners by including tokens and comments between the open and close tags
for each section. Tokens are replaced with values in the generated code. The following rules apply to
tokens in your CGT file:

• You can have only one token per line.
• Token values must not contain a ‘\t’ for formatting.

Note In the contents of your banner, C comment indicators, '/*' or '*/', can introduce an error in the
generated code.

An open tag includes tag attributes. Enclose the value of the attribute in double quotes. The
attributes available for an open tag are:

• width: specifies the width of the file or function banner comments in the generated code. The
default value is 80.

• style: specifies the boundary for the file or function banner comments in the generated code.

The open tag syntax is:

<OpenTag style = “style_value” width = “num_width”>

There are five options for the banner style. The CommentStyle and TargetLang configuration
object properties determine the use of C or C++ comment style. The built-in style options for the
style attribute are:

• classic

Using C style comments

/* single line comments */
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/*
 * multiple line comments
 * second line
 */

Using C++ style comments

// single line comments

//
// multiple line comments
// second line
//

• box

Using C style comments

/**********************************************************/
/* banner contents                                        */
/**********************************************************/

Using C++ style comments

////////////////////////////////////////////////////////////
// banner contents                                        //
////////////////////////////////////////////////////////////

• open_box

Using C style comments

/**********************************************************
 * banner contents
 **********************************************************/

Using C++ style comments

////////////////////////////////////////////////////////////
// banner contents
////////////////////////////////////////////////////////////

• doxygen

Using C style comments

/** single line comments */

/**
 * multiple line comments
 * second line
 */

Using C++ style comments

///single line comments

///
/// multiple line comments
///second line
///
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• doxygen_qt

Using C style comments

/*! single line comments */

/*!
 * multiple line comments
 * second line
 */

Using C++ style comments

//!single line comments

//!
//! multiple line comments
//!second line
//!

File Banner

This section contains comments and tokens for use in generating a custom file banner that precedes
the generated C and C++ code. If you omit the file banner section from the CGT file, the code
generator does not generate a file banner in the generated code. The file banner section provided in
the default CGT file is:
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom File Banner section (optional)
%% Customize File banners by using either custom tokens or the following
%% predefined tokens: 
%% %<FileName>, %<MATLABCoderVersion>, %<EmbeddedCoderVersion>
%% %<SourceGeneratedOn>, %<HardwareSelection>, %<OutputType>
%%
%% You can also use "custom tokens" in all of the sections below. See the 
%% documentation center for more details. 
%%
<FileBanner style="classic">
File: %<FileName>

MATLAB Coder version           : %<MATLABCoderVersion>
C/C++ source code generated on : %<SourceGeneratedOn>
</FileBanner>

Summary of Tokens for File Banner Generation
FileName Name of the generated file (for example, "kalman.c")
SourceGeneratedOn Timestamp of generated file
MATLABCoderVersion Version of MATLAB Coder
EmbeddedCoderVersion Version of Embedded Coder
HardwareSelection Selected target
OutputType Type of output (for example, lib, exe, or dll)

Function Banner

This section contains comments and tokens for use in generating a custom function banner that
precedes a generated C or C++ function. If you omit the function banner section from the CGT file,
the code generator does not generate function banners. The function banner section provided in the
default CGT file is:
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%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom Function Banner section (optional)
%% Customize function banners by using the following predefined tokens: 
%% %<FunctionName>, %<FunctionDescription>, %<FunctionPrototype>
%% %<Arguments>, %<ReturnType> 
%%
<FunctionBanner style="classic">
%<FunctionPrototype>
%<FunctionDescription>
Arguments    : %<Arguments>
Return Type  : %<ReturnType>
</FunctionBanner>

Summary of Tokens for Function Banner Generation

FunctionName Name of function
FunctionDescription Short abstract about the function

If the configuration parameter MATLABFcnDesc is true, the
function description appears in the function banner. Otherwise,
the code generator treats the function description as user
comments.

FunctionPrototype MATLAB function prototype

The function prototype appears in the function banner only if the
MATLABSourceComments configuration parameter is true.

Arguments List of function arguments
ReturnType Return type of function

Shared Utility Banner

This section contains comments and tokens for use in generating a custom shared utility function
banner that precedes a generated C or C++ shared utility function. If you omit the shared utility
function banner section from the CGT file, the code generator does not generate shared utility
function banners. The shared utility function banner section provided in the default CGT file is:
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom Shared Utility Function Banner section (optional)
%% Customize shared utility function banners by using the following 
%% predefined tokens: 
%% %<FunctionName>, %<FunctionDescription>
%% %<Arguments>, %<ReturnType>
%%
<SharedUtilityBanner style="classic">
Arguments    : %<Arguments>
Return Type  : %<ReturnType> 
</SharedUtilityBanner>

Summary of Tokens for Shared Utility Function Banner Generation

FunctionName Name of function
FunctionDescription Short abstract about the function
Arguments List of function arguments
ReturnType Return type of function
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File Trailer

The file trailer section contains comments for generating a custom file trailer that follows the
generated C or C++ code. If you omit the file trailer section from the CGT file, the code generator
does not generate a file trailer. The file trailer section provided in the default CGT file is:
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
%% Custom file trailer section (optional)
%% You can use any of the predefined tokens used for File Banner
%%
<FileTrailer style="classic">
File trailer for %<FileName>

[EOF]
</FileTrailer>

Tokens for the file banner are available for the file trailer. See Summary of Tokens for File Banner
Generation.

Include Files Banner

The include files banner section contains comments for generating a custom banner that precedes the
include files section in the generated code. If you omit the include files banner section from the CGT
file, the code generator does not generate a banner for this section. The include files banner section
provided in the default CGT file is:

<IncludeFilesBanner  style="classic">
Include Files
</IncludeFilesBanner>

Type Definitions Banner

The type definitions banner section contains comments for generating a custom banner that precedes
the type definitions section in the generated code. If you omit the type definitions banner section
from the CGT file, the code generator does not generate a banner for this section. The type
definitions banner section provided in the default CGT file is:

<TypeDefinitionsBanner  style="classic">
Type Definitions
</TypeDefinitionsBanner>

Named Constants Banner

The named constants banner section contains comments for generating a custom banner that
precedes the named constants section in the generated code. If you omit the named constants banner
section from the CGT file, the code generator does not generate a banner for this section. The named
constants banner section provided in the default CGT file is:

<NamedConstantsBanner  style="classic">
Named Constants
</NamedConstantsBanner>

Variable Declarations

The variable declarations banner section contains comments for generating a custom banner that
precedes the variable declarations section in the generated code. If you omit the variable
declarations banner section from the CGT file, the code generator does not generate a banner for this
section. The variable declarations banner section provided in the default CGT file is:
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<VariableDeclarationsBanner  style="classic">
Variable Declarations
</VariableDeclarationsBanner>

Variable Definitions

The variable definitions banner section contains comments for generating a custom banner that
precedes the variable definitions section in the generated code. If you omit the variable definitions
banner section from the CGT file, the code generator does not generate a banner for this section. The
variable definitions banner section provided in the default CGT file is:

<VariableDefinitionsBanner  style="classic">
Variable Definitions
</VariableDefinitionsBanner>

Function Declarations

The function declarations banner section contains comments for generating a custom banner that
precedes the function declarations section in the generated code. If you omit the function
declarations banner section from the CGT file, the code generator does not generate a banner for this
section. The function declarations banner section provided in the default CGT file is:

<functionDeclarationsBanner  style="classic">
Function Declarations
</FunctionDeclarationsBanner>

Function Definitions

The function definitions banner section contains comments for generating a custom banner that
precedes the function definitions section in the generated code. If you omit the function definitions
banner section from the CGT file, the code generator does not generate a banner for this section. The
function definitions banner section provided in the default CGT file is:

<FunctionDefinitionsBanner  style="classic">
Function Definitions
</FunctionDefinitionsBanner>

Custom Source Code

The custom source code banner section contains comments for generating a custom banner that
precedes the custom source code section in the generated code. If you omit the custom source code
banner section from the CGT file, the code generator does not generate a banner for this section. The
custom source code banner section provided in the default CGT file is:

<CustomSourceCodeBanner  style="classic">
Custom Source Code
</CustomSourceCodeBanner>

Custom Header Code

The custom header code banner section contains comments for generating a custom banner that
precedes the custom header code section in the generated code. If you omit the custom header code
banner section from the CGT file, the code generator does not generate a banner for this section. The
custom header code banner section provided in the default CGT file is:
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<CustomHeaderCodeBanner  style="classic">
Custom Header Code
</CustomHeaderCodeBanner>

See Also
coder.MATLABCodeTemplate

More About
• “Generate Custom File and Function Banners for C/C++ Code” on page 89-6
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Customize Generated Identifiers
In this section...
“Customize Identifiers by Using the MATLAB Coder App” on page 89-18
“Customize Generated Identifiers by Using the Command-Line Interface” on page 89-19

If you have Embedded Coder, you can customize the identifiers in C/C++ code generated from
MATLAB code. For each kind of identifier that you want to customize, set the appropriate identifier
format parameter to a macro that specifies the format of the generated identifiers. The macro can
include:

• Valid C or C++ language identifiers (a-z, A-Z, _, 0–9).
• The tokens listed in the following table. $M is required.

Token Description
$M Code generator inserts name mangling text to avoid naming collisions.

Required.
$N Code generator inserts the name of the object (global variable, global

type, local function, local temporary variable, or constant macro) for
which the identifier is generated. Improves readability of generated
code.

Required.
$R Code generator inserts the root project name into identifier, replacing

unsupported characters with the underscore (_) character.

Customize Identifiers by Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library
• Dynamic Library
• Executable

3 Click More Settings.
4 On the Code Appearance tab, under Identifier Format, for each kind of identifier that you

want to customize, enter the macro.

Parameter Default Macro
Global variables $M$N
Global types $M$N
Field name of global types $M$N
Local functions $M$N
Local temporary variables $M$N
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Parameter Default Macro
Constant macros $M$N
EMX Array Types emxArray_$M$N
EMX Array Utility Functions emx$M$N

For example, suppose that Global variables has the value glob_$M$N. For a global variable named
g, when name mangling is not required, the generated identifier is glob_g. If name mangling is
required, the generated identifier includes the name mangling text.

Customize Generated Identifiers by Using the Command-Line Interface
1 Create a code configuration object for a library or executable program. For example:

cfg = coder.config('lib','ecoder',true);
2 For each kind of identifier that you want to customize, specify the macro as a character vector.

Parameter Description Default Macro
CustomSymbolStrGlobalVar Global variables '$M$N'
CustomSymbolStrType Global types '$M$N'
CustomSymbolStrField Field name of global types '$M$N'
CustomSymbolStrFcn Local functions '$M$N'
CustomSymbolStrTmpVar Local temporary variables '$M$N'
CustomSymbolStrMacro Constant macros '$M$N'
CustomSymbolStrEMXArray EMX Array Types 'emxArray_$M$N'
CustomSymbolStrEMXArrayFcn EMX Array Utility Functions 'emx$M$N'

For example:

cfg.CustomSymbolStrGlobalVar = 'glob_$M$N';

For a global variable named g, when name mangling is not required, the generated identifier is
glob_g. If name mangling is required, the generated identifier includes the name mangling text.

See Also
coder.EmbeddedCodeConfig

More About
• “Configure Build Settings”
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Customize C/C++ File Names Generated from MATLAB Code
In this section...
“Customize File Names by Using the MATLAB Coder App” on page 89-20
“Customize Generated File Names by Using the Command-Line Interface” on page 89-20

If you have Embedded Coder, you can customize the file names of the C/C++ code generated from
MATLAB code. By changing the file names, you can avoid name clashes when integrating different
C/C++ code projects together. Customize the file names by setting the file name format parameter
CustomFileNameStr to a macro. The macro can include:

• Valid file name characters.
• The tokens listed in the following table. $M and $N are required.

Token Description
$M Code generator inserts name mangling text to avoid naming collisions.

Required.
$N Code generator inserts the non-customized file name.

Required.
$R Code generator inserts the root project name into the file name, replacing

unsupported characters with the underscore (_) character.

By default, the macro is set to $N$M.

Customize File Names by Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library
• Dynamic Library
• Executable

3 Click More Settings.
4 Enter the macro on the Code Appearance tab, next to Generated source and header files:

For example, suppose you set the macro to the value ec_$N$M. For an entry-point function called
foo, when name mangling is not required, the generated file name for foo becomes ec_foo. If name
mangling is required, the generated file name includes the name mangling text.

Customize Generated File Names by Using the Command-Line
Interface
1 Create a code generation configuration object for a library or executable program. For example:

cfg = coder.config('lib','ecoder',true);
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2 Specify the file name macro as a character vector in the CustomFileNameStr object property.
For example:

cfg.CustomFileNameStr = 'ec_$N$M';

For an entry-point function called foo, when name mangling is not required, the generated file
name for foo becomes ec_foo. If name mangling is required, the generated file name includes
the name mangling text.

See Also
coder.EmbeddedCodeConfig

More About
• “Configure Build Settings”
• “Customize Generated Identifiers” on page 89-18
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Control Signed Left Shifts in Generated Code
In this section...
“Control Signed Left Shifts Using the MATLAB Coder App” on page 89-22
“Control Signed Left Shifts Using the Command-Line Interface” on page 89-22

If you have an Embedded Coder license, you can control whether MATLAB Coder replaces
multiplications by powers of two with signed left bitwise shifts. Some coding standards, such as
MISRA, do not allow bitwise operations on signed integers.

By default, MATLAB Coder replaces multiplication by powers of two with signed left shifts. Here is an
example of generated C code that uses a signed left shift for multiplication by eight.

i <<= 3;

To increase the likelihood of generating MISRA C:2012 compliant code, disable the replacement of
multiplication by powers of two with signed left shifts. Here is an example of generated C code that
does not use a signed left shift for multiplication by eight:

i = i * 8;

Control Signed Left Shifts Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library (.lib)
• Dynamic Library (.dll)
• Executable (.exe)

3 Click More Settings.
4 On the Code Appearance tab, select or clear the Use signed shift left for fixed-point

operations and multiplication by powers of 2 check box.

Control Signed Left Shifts Using the Command-Line Interface
1 Create a code configuration object for 'lib', 'dll', or 'exe'. For example:

cfg = coder.config('lib','ecoder',true); % or dll or exe
2 Set the EnableSignedLeftShifts property to true or false. For example:

cfg.EnableSignedLeftShifts = false;

See Also
coder.EmbeddedCodeConfig

More About
• “Configure Build Settings”
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Control Data Type Casts in Generated Code
In this section...
“Specify Casting Mode Using the MATLAB Coder App” on page 89-24
“Specify Casting Mode Using the Command-Line Interface” on page 89-24

If you have an Embedded Coder license, you can control data type casts in C/C++ code generated
from MATLAB code. You can specify one of the following casting modes.

Casting Mode Description
Nominal Nominal casting mode is the default casting

mode. Generated C/C++ code uses the default C
compiler data type casting. When you do not have
special data type information requirements,
choose this option. Here is an example of code
generated using nominal casting mode:

short addone(short x)
{
  int i;
  i = x + 1;
  if (i > 32767) {
    i = 32767;
  }

  return (short)i;
}

Standards Compliant Generated C/C++ code has data type casts that
conform to MISRA standards. The MISRA data
type casting eliminates common MISRA standard
violations, including address arithmetic and
assignment. It reduces 10.1, 10.2, 10.3, and 10.4
violations. Here is an example of code generated
using standards-compliant casting mode:

short addone(short x)
{
  int i;
  i = (int)x + (int)1;
  if (i > (int)32767) {
    i = (int)32767;
  }

  return (short)i;
}
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Casting Mode Description
Explicit Generated C/C++ code has explicit data type

casts. Explicit data type casts provide information
about the amount of memory that the variable
uses and the level of precision for calculations
using the variable. Here is an example of code
generated using explicit casting mode:

short addone(short x)
{
  int i;
  i = (int)x + 1;
  if (i > 32767) {
    i = 32767;
  }

  return (short)i;
}

Specify Casting Mode Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library (.lib)
• Dynamic Library (.dll)
• Executable (.exe)

3 Click More Settings.
4 On the All Settings tab, under Advanced, set Casting mode to one of the following values:

• Nominal
• Standards Compliant
• Explicit

Specify Casting Mode Using the Command-Line Interface
1 Create a code configuration object for 'lib', 'dll', or 'exe'. For example:

cfg = coder.config('lib','ecoder',true); % or dll or exe
2 Set the CastingMode property to one of the following values:

• 'Nominal'
• 'Standards'
• 'Explicit'

For example:

cfg.CastingMode = 'Standards';
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See Also
coder.EmbeddedCodeConfig

More About
• “Configure Build Settings”
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Simplify Multiply Operations for Array Indexing in Loops
If you use Embedded Coder to generate C/C++ code from MATLAB code, you can enable an
optimization that simplifies array indexing in loops in the generated code. When possible, for array
indices in loops, this optimization replaces multiply operations with add operations. Multiply
operations can be expensive. This optimization, referred to as strength reduction, is useful when the
C/C++ compiler on the target platform does not optimize the array indexing.

Here is code generated without the optimization:

for (i = 0; i < 10; i++) {
    z[5 * (1 + i) - 1] = x[5 * (1 + i)];
  }

Here is code generated with the optimization:

for (b_i = 0; b_i < 10; b_i++) {
    z[i + 4] = x[i + 5];
    i += 5;
  }

By default, the strength reduction optimization is disabled. To enable it:

• At the command line, set the configuration object parameter EnableStrengthReduction to
true.

• In the MATLAB Coder app, project build settings, on the All Settings tab, set Simplify array
indexing to Yes.

Even when the optimization replaces the multiply operations in the generated code, it is possible that
the C/C++ compiler can generate multiply instructions.

See Also

More About
• “Optimization Strategies”
• “Configure Build Settings”
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Generate SIMD Code for MATLAB Functions
You can generate SIMD (single instruction, multiple data) code from certain MATLAB functions by
using Intel AVX and Intel SSE technology. SIMD is a computing paradigm in which a single
instruction processes multiple data. Many modern processors have SIMD instructions that, for
example, perform several additions or multiplications at once. For computationally intensive
operations among supported functions, SIMD intrinsics can significantly improve the performance of
the generated code on Intel platforms.

MATLAB Functions That Support SIMD Code
When certain conditions are met, you can generate SIMD code by using Intel SE or Intel AVX
technology. The following table lists MATLAB functions that support SIMD code generation. The table
also details the conditions under which the support is available.

MATLAB Function Conditions
plus • For Intel AVX and Intel SSE, the input signal

has a data type of single, double, int8,
int16, int32 or int64.

• For Intel AVX-512, the input signal has a data
type of single or double.

minus • For Intel AVX and Intel SSE, the input signal
has a data type of single, double, int8,
int16, int32 or int64.

• For Intel AVX-512, the input signal has a data
type of single or double.

times • For Intel AVX and Intel SSE, the input signal
has a data type of single, double, int16, or
int32.

• For Intel AVX-512, the input signal has a data
type of single or double.

rdivide The input signal has a data type of single or
double.

sqrt The input signal has a data type of single or
double.

ceil • For Intel SSE and Intel AVX, the input signal
has a data type of single or double.

• Intel AVX-512 is not supported.
floor • For Intel SSE and Intel AVX, the input signal

has a data type of single or double.
• Intel AVX-512 is not supported.

max The input signal has a data type of single or
double.

min The input signal has a data type of single or
double.
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If you have a DSP System Toolbox, you can generate SIMD code from certain MATLAB System
objects. For more information, see “System objects in DSP System Toolbox that Support SIMD Code
Generation” (DSP System Toolbox).

Generate SIMD Code Versus Plain C Code
Consider the MATLAB function dynamic. This function consists of addition and multiplication
operations between the variable-size arrays A and B. These arrays have a data type of single and an
upper bound of 100 x 100.

function C = dynamic(A, B)
   assert(all(size(A) <= [100 100]));
   assert(all(size(B) <= [100 100]));
   assert(isa(A, 'single'));
   assert(isa(B, 'single'));

   C = zeros(size(A), 'like', A);
   for i = 1:numel(A)
       C(i) = (A(i) .* B(i)) + (A(i) .* B(i));
   end
end

To generate plain C code at the command line:

1 For C library code generation, create a coder.config object

cfg = coder.config('lib');
2 To generate a static library in the default location, codegen\lib\dynamic, use the codegen

function t.

codegen('-config', cfg, 'dynamic');
3 In the list of generated files, click dynamic.c. In the plain (non-SIMD) C code, each loop

iteration produces one result.
void dynamic(const float A_data[], const int A_size[2], const float B_data[],
             const int B_size[2], float C_data[], int C_size[2])
{
  float C_data_tmp;
  int i;
  int loop_ub;
  (void)B_size;
  C_size[0] = (signed char)A_size[0];
  C_size[1] = (signed char)A_size[1];
  loop_ub = (signed char)A_size[0] * (signed char)A_size[1];
  if (0 <= loop_ub - 1) {
    memset(&C_data[0], 0, loop_ub * sizeof(float));
  }
  loop_ub = A_size[0] * A_size[1];
  for (i = 0; i < loop_ub; i++) {
    C_data_tmp = A_data[i] * B_data[i];
    C_data[i] = C_data_tmp + C_data_tmp;
  }
}

To generate SIMD C code at the command line:

1 For C library code generation, use the coder.config function to create a coder.CodeConfig
object.

cfg = coder.config('lib');
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2 Set the coder.HardwareImplementation object TargetHWDeviceType property to 'Intel-
>x86-64 (Linux 64)' or 'Intel->x86-64 (Windows64)'.
cfg.HardwareImplementation.TargetHWDeviceType = 'Intel->x86-64 (Windows64)';

3 Set the coder.HardwareImplementation object ProdHWDeviceType property to 'Intel-
>x86-64 (Linux 64)' or 'Intel->x86-64 (Windows64)'
cfg.HardwareImplementation.TargetHWDeviceType = 'Intel->x86-64 (Windows64)';

If you are using the MATLAB Coder app to generate code:

• Set the Hardware Device parameter to None-Select device below.
• Set the Device vendor parameter to Intel or AMD.
• Set the Device type to Intel->x86-64 (Linux 64) or Intel->x86-64 (Windows64).

4 Set the CodeReplacementLibrary property to an Intel AVX or Intel SSE library. This example
uses Intel SSE for Windows.

cfg.CodeReplacementLibrary = 'Intel SSE (Windows)';

The library that you choose depends on which instruction set extension your processor supports.

For more information, see https://www.intel.com/content/www/us/en/support/articles/000005779/
processors.html. This table lists which Intel intrinsic instructions sets each code replacement
library contains.

Code Replacement Library Intel Intrinsic Instruction Set
Intel SSE SSE, SSE2, SSE4.1
Intel AVX SSE, SSE2, SSE4.1, AVX, AVX2
Intel AVX-512 SSE, SSE2, SSE4.1, AVX, AVX2, AVX-512

If you are using the MATLAB Coder app to generate code, on the Custom Code tab, set the
Code replacement library parameter to an Intel SSE or Intel AVX library.

5 Use the codegen function to generate a static library in the default location, codegen\lib
\dynamic.

codegen('-config', cfg, 'dyanamic');
6 In the list of generated files, click dynamic.c.

void dynamic(const float A_data[], const int A_size[2], const float B_data[],
             const int B_size[2], float C_data[], int C_size[2])
{
  __m128 r;
  float C_data_tmp;
  int i;
  int loop_ub;
  int scalarLB;
  int vectorUB;
  (void)B_size;
  C_size[0] = (signed char)A_size[0];
  C_size[1] = (signed char)A_size[1];
  loop_ub = (signed char)A_size[0] * (signed char)A_size[1];
  if (0 <= loop_ub - 1) {
    memset(&C_data[0], 0, loop_ub * sizeof(float));
  }
  loop_ub = A_size[0] * A_size[1];
  scalarLB = (loop_ub / 4) << 2;
  vectorUB = scalarLB - 4;
  for (i = 0; i <= vectorUB; i += 4) {
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    r = _mm_mul_ps(_mm_loadu_ps(&A_data[i]), _mm_loadu_ps(&B_data[i]));
    _mm_storeu_ps(&C_data[i], _mm_add_ps(r, r));
  }
  for (i = scalarLB; i < loop_ub; i++) {
    C_data_tmp = A_data[i] * B_data[i];
    C_data[i] = C_data_tmp + C_data_tmp;
  }
}

The SIMD instructions are the intrinsic functions that start with the identifier _mm. These
functions process multiple data in a single iteration of the loop because the loop increments by
four for single data types. For double data types, the loop increments by two. For MATLAB
code that processes more data and is more computationally intensive, than the code in this
example, the presence of SIMD instructions can significantly speed up the code execution time.

The second for loop is in the generated code because the for loop that contains SIMD code
must be divisible by four for single data types. The second loop processes the remainder of the
data.

For a list of a Intel intrinsic functions for supported MATLAB functions, see https://software.intel.com/
sites/landingpage/IntrinsicsGuide/.

Limitations
The generated code is does not contain SIMD code when the MATLAB code meets these conditions:

• Scalar operations outside a loop. For example, if a,b, and c are scalars, the generated code does
not contain SIMD code for an operation such as c=a+b.

• Indirectly indexed arrays or matrices. For example, if A,B,C, and D are vectors, the generated
code does not contain SIMD code for an operation such as D(A)=C(A)+B(A).

• Parallel for-Loops (parfor). The parfor loop does not contain SIMD code, but loops within the
body of the parfor loop might contain SIMD code.

See Also

More About
• “What Is Code Replacement?”
• “Generate C Code by Using the MATLAB Coder App”
• “Generate C Code at the Command Line”
• “Generate SIMD Code from Simulink Blocks” on page 72-58
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Generate C/C++ Code with Improved MISRA Compliance
The Motor Industry Software Reliability Association (MISRA)12 has established “Guidelines for the
Use of the C Language in Critical Systems” (MISRA C). When you generate code from MATLAB code,
if you have Embedded Coder, you can configure certain code generation parameters to increase the
likelihood of generating C and C++ code that comply with the MISRA C:2012 and MISRA C++:2008
guidelines.

The following describes the separate command line and app workflows.

Configure Code Generation Configuration Object Properties
1 Create an Embedded Coder code generation configuration object.

cfg = coder.config('lib', 'ecoder', true);
2 Set the properties listed in the table to the values for improved MISRA compliance.

Property Value for Improved MISRA Compliance
CastingMode 'Standards'
CppNamespace Any valid namespace name for C++
DataTypeReplacement 'CoderTypedefs'
DynamicMemoryAllocation 'Off'
EnableRuntimeRecursion false
EnableSignedLeftShifts false
EnableSignedRightShifts false
GenerateDefaultInSwitch true
ParenthesesLevel 'Maximum'
TargetLangStandard 'C99 (ISO)' for C, 'C++03 (ISO)' for C+

+

To set these properties in one step, use coder.setupMISRAConfig.

coder.setupMISRAConfig(cfg);

Alternatively, set properties individually. For example:

cfg.CastingMode = 'Standards';

If the CppNamespace property is unset, and the TargetLang property is 'C++', then
coder.setupMISRAConfig sets the CppNamespace property to a default character vector,
'Codegen'. Modify this value to a namespace name that is particular to your project.

3 Pass the configuration object to codegen by using the -config option.

codegen myFunction -config cfg ...

12. MISRA and MISRA C are registered trademarks of HORIBA MIRA Ltd., held on behalf of the MISRA Consortium.

 Generate C/C++ Code with Improved MISRA Compliance

89-31



Configure MATLAB Coder App Settings
1 On the Generate Code page, set Build type to Source Code, Static Library, Dynamic

Library, or Executable.
2 Click More Settings.
3 Click MISRA Compliance.

The app displays the settings that might impact MISRA compliance.

4 To set all of these settings to the recommended values, click Set to Recommended Values.

To modify an individual setting, click All Settings, and then search for the setting.

Additional Settings for MISRA C++ Compliance
By default, the C++ code that you generate uses a custom type definition for bool to maximize
compatibility with certain precompiled libraries. This custom type definition can cause violations for
MISRA C++:2008 Rule 5-0-13 and Rule 5-3-1.

To use the built-in bool type in generated C++ code, and avoid these violations, change the
Hardware Board setting in the configuration object from MATLAB Host Computer. To see how to
change this setting in the App, see “Access Hardware Implementation Properties with a Dialog Box”.
For example, for code generation and build on a 64-bit Windows platform, change the Hardware
Board to None - Select device below, and then set Device vendor to Intel and Device type
to x86-64 (Windows64).

See Also
coder.EmbeddedCodeConfig | coder.setupMISRAConfig

More About
• “Control Signed Left Shifts in Generated Code” on page 89-22
• “Control Data Type Casts in Generated Code” on page 89-23
• “Specify Data Types Used in Generated Code”
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• “Change the Standard Math Library”
• “Code Generation for Recursive Functions”
• “Configure Build Settings”

External Websites
• www.misra.org.uk
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Customize Data Type Replacement
While generating C/C++ code from MATLAB code, the Data Type Replacement option enables you
to use built-in C data types or MathWorks typedefs in the generated code. Code generation supports
these data types for custom renaming: double, single, uint8, uint16, uint32, uint64, int8,
int16, int32, int64, char, and logical.

The Data Type Replacement option is available in the Generate Code window (More Settings), on
the Code Appearance tab. You can select one of these options:

• Use built-in C data types in the generated code
• Use MathWorks typedefs in the generated code

If you have Embedded Coder installed, you can specify custom names for MATLAB built-in data types
in the generated C/C++ code. For example, you can customize double as Custom_Double.

Specify Custom Data Type Names by Using the MATLAB Coder App
To specify custom names for the MATLAB data types:

1 Open the MATLAB Coder app.
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2 Navigate to the Generate Code step.
3 Click More Settings.
4 In the Code Appearance tab, select Enable custom data type replacement under Custom

Data Type Replacement.
5 The table lists the name of the supported data types. Specify your custom names for these data

types and press Enter. The specified custom names replace the built-in data type names in the
generated code. If you do not specify a custom name, the code generator uses a default name.

Specify Custom Data Type Names by Using the Command-Line
Interface
Use the EnableCustomReplacementTypes and ReplacementTypes properties in an Embedded
Coder configuration object when you generate code by using codegen.

1 Write a MATLAB function from which you can generate code. This example uses the function
myAdd that returns the sum of its inputs.

function c = myAdd(a,b)
c = a + b;
end

2 Create a code configuration object for generation of a static library.

cfg = coder.config('lib','ecoder',true);
3 Set the EnableCustomReplacementTypes property to true.

cfg.EnableCustomReplacementTypes = true;
4 Specify custom name for the data types. Here, the built-in data type name uint8 is customized

to Custom_Uint8.

cfg.ReplacementTypes.uint8 = "Custom_Uint8";
5 Generate code by using codegen and -config option.

codegen myAdd.m -args {1,uint8(1)} -config cfg -report

See Also
Functions
codegen | coder.config

Objects
coder.CodeConfig | coder.EmbeddedCodeConfig | coder.ReplacementTypes

More About
• “Import Custom Data Type Definitions from External Header Files” on page 89-36

 Customize Data Type Replacement

89-35



Import Custom Data Type Definitions from External Header
Files

By default, MATLAB Coder uses the predefined data types in the generated code. You can use
customized data type names by importing custom type definitions from external header files. You can
then use your own type definitions in the generated C/C++ code. If you have existing legacy code,
you can integrate that code, in the generated C/C++ code. You can import a header file by using
either the MATLAB Coder app or the command-line interface.

Import Custom Types by Using the MATLAB Coder App
To import custom types from external header files:

1 Open the MATLAB Coder app and proceed to the Generate Code page.
2 Click More Settings.
3 In the Code Appearance tab, select Enable custom data type replacement.
4 Specify your custom names for the data types in Enable custom data type replacement table

and press Enter.
5 Select the Import custom types from external header files check box.
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6 In the Header files text field, enter a semicolon-separated list of external header file names and
press Enter. For example, myHeader1.h;myHeader2.h;myHeader3.h.

Import Custom Types by Using the Command-Line Interface
Use the ReplacementTypes.IsExtern and ReplacementTypes.HeaderFiles properties in a
coder.EmbeddedCodeConfig object when you generate code by using codegen.

1 Create a code configuration object for generation of a static library.

cfg = coder.config('lib','ecoder',true);
2 Specify custom names for the data types. For example, double is named as Custom_Double and

int8 is named as Custom_Int8 in the code.

cfg.EnableCustomReplacementTypes = true;
cfg.ReplacementTypes.double = "Custom_Double";
cfg.ReplacementTypes.int8 = "Custom_Int8";

3 Specify configuration properties for importing the external header files.

% Include single header file

cfg.ReplacementTypes.IsExtern = true;
cfg.ReplacementTypes.HeaderFiles = "myHeader.h";
cfg.CustomInclude = 'C:\myFiles'; % Include path of the header file

% Include multiple header files

cfg.ReplacementTypes.IsExtern = true;
cfg.ReplacementTypes.HeaderFiles = "myHeader1.h;myHeader2.h;myHeader3.h";
cfg.CustomInclude = '"C:\Program Files\MATLAB\myFiles"'; % Include path of the header files

For more information on CustomInclude, see “Configure Build by Using the Configuration
Object”.

4 Generate code by using codegen and the -config option.

codegen myAdd.m -args {1,int8(1)} -config cfg -report

See Also
Functions
codegen | coder.cinclude | coder.config

Objects
coder.CodeConfig | coder.EmbeddedCodeConfig | coder.ReplacementTypes

More About
• “Customize Data Type Replacement” on page 89-34
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MATLAB Code Patterns That Require a Nonempty Initialize
Function in Generated Code

Issue
When generating standalone code from MATLAB code, you choose not to generate the initialize
function:

• In a coder.EmbeddedCodeConfig object, IncludeInitializeFcn is set to false.
• Alternatively, in the MATLAB Coder app, on the All Settings tab, Initialize Function Required

is set to No.

Also, you ensure that the custom code to appear in the generated initialize function is empty:

• In a coder.EmbeddedCodeConfig object, CustomInitializer is set to ''.
• Alternatively, in the MATLAB Coder app, on the Custom Code tab, Custom C Code for

Generated Files for initialize function is empty.

You still get this error message:

The initialize function is not empty, but the IncludeInitializeFcn configuration setting requests that
the initialize function be omitted.

Solution
In certain situations, the code generator determines that the initialize function must be nonempty and
produces code for the initialize function. This code generation can occur even if the custom code for
the initialize function that you specify is empty. Not including this generated code in the initialize
function causes the generated entry-point functions to operate on an invalid state. In such situations,
if you choose to not generate the initialize function, the code generator produces an error message.

To fix this issue, include the initialize function in your generated code by doing one of the following:

• In a coder.EmbeddedCodeConfig object, set IncludeInitializeFcn to true (this value is
the default value).

• In the MATLAB Coder app, on the All Settings tab, set Initialize Function Required to Yes
(this setting is the default setting).

Examples of MATLAB code patterns that require a nonempty initialize function in the generated code
are:

• Your MATLAB code contains an operation that can generate nonfinite values (Inf or NaN). For
example, define a MATLAB function foo that calls factorial. The factorial function grows
quickly and returns Inf for inputs greater than a certain threshold. For an input of type double,
the threshold is 170. Executing factorial(171) in MATLAB returns Inf.

function y = foo(a)
y = factorial(a);
end

Generate a static library for foo. In the coder.EmbeddedCodeConfig object cfg, set the
parameter CustomInitializer to an empty character array. Set the parameter
IncludeInitializeFcn to true. These values are the default values for the parameters.
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cfg = coder.config('lib');

cfg.CustomInitializer = '';  %These are the default values
cfg.IncludeInitializeFcn = true;

codegen -config cfg foo -args {1}

The code generator automatically produces a nonempty initialize function foo_initialize that
calls supporting code for nonfinite data. This function calls rt_InitInfAndNaN, which is defined
in another generated file rt_nonfinite.c.

/* Include Files */
#include "foo_initialize.h"
#include "foo.h"
#include "foo_data.h"
#include "rt_nonfinite.h"

/* Function Definitions */

/*
 * Arguments    : void
 * Return Type  : void
 */
void foo_initialize(void)
{
  rt_InitInfAndNaN();
  isInitialized_foo = true;
}

/*
 * File trailer for foo_initialize.c
 *
 * [EOF]
 */

• Your MATLAB code uses global or persistent variables. For example, define this MATLAB
function:

function y = bar
global g
y = g;
end

Generate a static library for bar. Specify the initial value of g as 1. In the
coder.EmbeddedCodeConfig object cfg, set the parameter CustomInitializer to an empty
character array. Set the parameter IncludeInitializeFcn to true. These values are the
default values for the parameters.

cfg = coder.config('lib');

cfg.CustomInitializer = '';  %These are the default values
cfg.IncludeInitializeFcn = true;

codegen -config cfg -globals {'g',1} bar

The code generator automatically produces a nonempty initialize function bar_initialize that
initializes g.
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/* Include Files */
#include "bar_initialize.h"
#include "bar.h"
#include "bar_data.h"

/* Function Definitions */

/*
 * Arguments    : void
 * Return Type  : void
 */
void bar_initialize(void)
{
  g = 1.0;
  isInitialized_bar = true;
}

/*
 * File trailer for bar_initialize.c
 *
 * [EOF]
 */

See Also
coder.EmbeddedCodeConfig

More About
• “Use Generated Initialize and Terminate Functions”
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Storage Classes for Code Generation
from MATLAB Code

• “Storage Classes for Code Generation from MATLAB Code” on page 90-2
• “Control Declarations and Definitions of Global Variables in Code Generated from MATLAB Code”

on page 90-4

90



Storage Classes for Code Generation from MATLAB Code
If you have an Embedded Coder license, you can use storage classes to control the declaration and
definition of a global variable in the generated C/C++ code.

In the context of code generation, a storage class is a specification that determines the declaration
and definition of a variable in the generated code. For code generation, the term storage class is not
the same as the C language term storage class specifier.

Storage classes help you to integrate generated code with external code. You can make a generated
variable visible to external code. You can also make variables declared in the external code visible to
the generated code. For code generation from MATLAB code, you can use storage classes with global
variables only. The storage class determines:

• The file placement of a global variable declaration and definition.
• Whether the global variable is imported from external code or exported for use by external code.

To assign a storage class to a global variable, in your MATLAB code, use the coder.storageClass
function. Only when you use an Embedded Coder project or configuration object for generation of C/C
++ libraries or executables does the code generator recognize coder.storageClass calls.

The syntax for coder.storageClass is:

coder.storageClass(global_name, storage_class)

global_name is the name of a global variable, specified as a character vector. global_name must
be a compile-time constant.

storage_class can be one of the following values.

Storage Class Description
'ExportedGlobal' • Defines the variable in the Variable

Definitions section of the C file
entry_point_name.c.

• Declares the variable as an extern in the
Variable Declarations section of the
header file entry_point_name.h

• Initializes the variable in the function
entry_point_name_initialize.h.

'ExportedDefine' Declares the variable with a #define directive in
the Exported data define section of the
header file entry_point_name.h.

'ImportedExtern' Declares the variable as an extern in the
Variable Declarations section of the header
file entry_point_name_data.h. The external
code must supply the variable definition.

'ImportedExternPointer' Declares the variable as an extern pointer in the
Variable Declarations section of the header
file entry_point_name_data.h. The external
code must define a valid pointer variable.
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Storage classes have these requirements and limitations:

• Assign the storage class to a global variable in a function that declares the global variable. You do
not have to assign the storage class in more than one function.

• After you assign a storage class to a global variable, you cannot assign a different storage class to
that global variable.

• You cannot assign a storage class to a constant global variable.
• A global variable with an ExportedDefine storage class must be a scalar but not a complex or

multi-word scalar. The global variable must only be read and not written to in the code.

If you do not assign a storage class to a global variable, except for the declaration location, the
variable behaves like it has an 'ExportedGlobal' storage class. For an 'ExportedGlobal'
storage class, the global variable is declared in the file entry_point_name.h. When the global
variable does not have a storage class, the variable is declared in the file
entry_point_name_data.h.

See Also
coder.storageClass

Related Examples
• “Control Declarations and Definitions of Global Variables in Code Generated from MATLAB

Code” on page 90-4
• “Generate Code for Global Data”
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Control Declarations and Definitions of Global Variables in
Code Generated from MATLAB Code

This example uses storage classes to control the declarations and definitions of global variables in
C/C++ code generated from MATLAB code. Using storage classes helps you to interface generated
code with external code.

This example requires an Embedded Coder license.

Write a function addglobals that adds four global variables. Declare the global variables in the
function.

function y = addglobals %#codegen
% Define the global variables.
global u;
global v;
global x;
global z;

% Assign the storage classes.
coder.storageClass('u','ExportedGlobal');
coder.storageClass('v','ImportedExtern');
coder.storageClass('x','ImportedExternPointer');
coder.storageClass('z','ExportedDefine');
y = u + v + x + z;
end

Create a file c:\myfiles\myfile.c that defines and initializes the imported global variables u and
v.

#include <stdio.h>

/* Variable definitions for imported variables */ 
double v = 1.0;
double *x = &v;

Create a code configuration object. Configure the code generation parameters to include myfile.c.
For output type 'lib', or if you generate source code only, you can generate code without providing
this file. Otherwise, you must provide this file.

cfg = coder.config('dll','ecoder', true);
cfg.CustomSource = 'myfile.c';
cfg.CustomInclude = 'c:\myfiles';

Generate the code. This example uses the -globals argument to specify the types and initial values
of the global variables u, v, x, and z. Alternatively, you can define global variables in the MATLAB
global workspace. For the imported global variables v and x, the code generator uses the initial
values only to determine the type.

codegen -config cfg -globals {'u', 1, 'v', 2, 'x', 3, 'z', 4} addglobals -report

From the initial values 1, 2, 3, and 4 codegen determines that u, v, x and z have type double.
codegen defines and declares the exported global variables u and z. It generates code that initializes
u to 1.0 and z to 4.0. codegen declares the imported global variables v and x. It does not define
these variables or generate code that initializes them. myfile.c provides the code that defines and
initializes v and x.
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To view the code generated for the global variables, open the report. Click the View report link.

View the definition for the exported global z in the Exported data define section in
addglobals.h.

/* Definition for custom storage class: ExportedDefine */
#define z                              4.0

View the definition and declaration for the exported global u.

• u is defined in the Variable Definitions section in addglobals.c.

/* Variable Definitions */
/* Definition for custom storage class: ExportedGlobal */
double u;

• u is declared as extern in the Variable Declarations section in addglobals.h.

/* Variable Declarations */
/* Declaration for custom storage class: ExportedGlobal */
extern double u;

• u is initialized in addglobals_initialize.c.

/* Include Files */
#include "addglobals_initialize.h"
#include "addglobals.h"
#include "addglobals_data.h"

/* Function Definitions */

/*
 * Arguments    : void
 * Return Type  : void
 */
void addglobals_initialize(void)
{
  u = 1.0;
  isInitialized_addglobals = true;
}

View the definition and declaration for the imported external global v and the imported external
global pointer x.

v and x are declared as extern in the Variable Declarations section in addglobals_data.h.

/* Variable Declarations */
/* Declaration for custom storage class: ImportedExtern */
extern double v;

/* Declaration for custom storage class: ImportedExternPointer */
extern double *x;

See Also
coder.storageClass
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More About
• “Storage Classes for Code Generation from MATLAB Code” on page 90-2
• “Generate Code for Global Data”
• “Configure Build for External C/C++ Code”
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Verification of Code Generated from
MATLAB Code

• “Highlight Potential Data Type Issues in a Report” on page 91-2
• “Find Potential Data Type Issues in Generated Code” on page 91-4
• “PIL Execution with ARM Cortex-A at the Command Line” on page 91-9
• “PIL Execution with ARM Cortex-A by Using the MATLAB Coder App” on page 91-11
• “Interactively Trace Between MATLAB Code and Generated C/C++ Code” on page 91-12
• “Polyspace Verification of C/C++ Code Generated by MATLAB Coder” on page 91-22
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Highlight Potential Data Type Issues in a Report
In this section...
“Enable Highlight Option Using the MATLAB Coder App” on page 91-2
“Enable Highlight Option Using the Command Line Interface” on page 91-2

If you have Embedded Coder, you have the option to highlight potential data types issues in the code
generation report for standalone code generated from MATLAB code. If you enable this option, on the
Code Insights tab, the report identifies single-precision and double-precision operations in the
generated C/C++ code. If you have Fixed-Point Designer, the report also identifies expensive fixed-
point operations.

To view potential data type issues in a code generation report:

1 Click the Code Insights tab.
2 Expand the Potential data type issues section.
3 Expand the data type issues section that you want to see.

For example, this report identifies MATLAB code that results in double-precision operations in
the generated code.

The option to highlight potential data type issues is disabled by default.

Enable Highlight Option Using the MATLAB Coder App
1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library (.lib)
• Dynamic Library (.dll)
• Executable (.exe)

3 Click More Settings.
4 On the Debugging tab, select the Always create a report and Highlight potential data type

issues check boxes.

Enable Highlight Option Using the Command Line Interface
1 Create an embedded code configuration object for 'lib', 'dll', or 'exe':

cfg = coder.config('lib','ecoder',true); % or dll or exe
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2 Set the GenerateReport and HighlightPotentialDataTypeIssues configuration object
properties to true:

cfg.GenerateReport = true;
cfg.HighlightPotentialDataTypeIssues = true;

See Also

Related Examples
• “Find Potential Data Type Issues in Generated Code” on page 91-4
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Find Potential Data Type Issues in Generated Code

In this section...
“Data Type Issues Overview” on page 91-4
“Enable Highlighting of Potential Data Type Issues” on page 91-4
“Find and Address Cumbersome Operations” on page 91-5
“Find and Address Expensive Rounding” on page 91-5
“Find and Address Expensive Comparison Operations” on page 91-6
“Find and Address Multiword Operations” on page 91-7

Data Type Issues Overview
When you generate C code from MATLAB code, you can highlight potential data type issues in the C
code generation report. The report highlights MATLAB code that requires single-precision, double-
precision, or expensive fixed-point operations. The expensive fixed-point operations checks require a
Fixed-Point Designer.

• The double-precision check highlights expressions that result in a double-precision operation.
When trying to achieve a strict-single or fixed-point design, manual inspection of code can be
time-consuming and error prone.

For a strict-single precision design, specify a standard math library that supports single-precision
implementations. To change the library for a project, during the Generate Code step, in the project
settings dialog box, on the Custom Code tab, set the Standard math library to C99 (ISO).

• The single-precision check highlights expressions that result in a single operation.
• The expensive fixed-point operations check identifies optimization opportunities for fixed-point

code. It highlights expressions in the MATLAB code that require cumbersome multiplication or
division, expensive rounding, expensive comparison, or multiword operations. For more
information on optimizing generated fixed-point code, see “Tips for Making Generated Code More
Efficient” (Fixed-Point Designer).

Enable Highlighting of Potential Data Type Issues
Enable the highlight option using the MATLAB Coder app

1 On the Generate Code page, to open the Generate dialog box, click the Generate arrow .
2 Set Build type to one of the following:

• Source Code
• Static Library (.lib)
• Dynamic Library (.dll)
• Executable (.exe)

3 Click More Settings.
4 On the Debugging tab, select the Always create a report and Highlight potential data type

issues check boxes.
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Enable the highlight option using the command-line interface

1 Create an embedded code configuration object for 'lib', 'dll', or 'exe':

cfg = coder.config('lib','ecoder',true); % or dll or exe
2 Set the GenerateReport and HighlightPotentialDataTypeIssues configuration object

properties to true:

cfg.GenerateReport = true;
cfg.HighlightPotentialDataTypeIssues = true;

Find and Address Cumbersome Operations
Cumbersome operations usually occur due to an insufficient range of output. Avoid inputs to a
multiply or divide operation that have word lengths larger than the base integer type of your
processor. Software can process operations with larger word lengths, but this approach requires
more code and runs slower.

This example requires Embedded Coder and Fixed-Point Designer. The target word length for the
processor in this example is 64.

1 Create the function myMul.

function out = myMul(in1, in2)
    out = fi(in1*in2, 1, 64, 0);
end

2 Generate code for myMul.

cfg = coder.config('lib');
cfg.GenerateReport = true;
cfg.HighlightPotentialDataTypeIssues = true;
fm = fimath('ProductMode', 'SpecifyPrecision', 'ProductWordLength', 64);
codegen -config cfg myMul -args {fi(1, 1, 64, 4, fm), fi(1, 1, 64, 4, fm)}

3 Click View report.
4 In the code generation report, click the Code Insights tab.
5 Expand the Potential data type issues section. Then, expand the Expensive fixed-point

operations section.

The report flags the expression in1 * in2. To resolve the issue, modify the data types of in1
and in2 so that the word length of the product does not exceed the target word length of 64.

Find and Address Expensive Rounding
Traditional handwritten code, especially for control applications, almost always uses "no effort"
rounding. For example, for unsigned integers and two's complement signed integers, shifting right
and dropping the bits is equivalent to rounding to floor. To get results comparable to, or better than,
what you expect from traditional handwritten code, use the floor rounding method.

This example requires Embedded Coder and Fixed-Point Designer.
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1 Create the function myRounding.

function [quot] = myRounding(in1, in2)
   quot = in1 / in2;
end

2 Generate code for myRounding.

cfg = coder.config('lib');
cfg.GenerateReport = true;
cfg.HighlightPotentialDataTypeIssues = true;
codegen -config cfg myRounding -args {fi(1, 1, 16, 2), fi(1, 1, 16, 4)}

3 Click View report.
4 In the code generation report, click the Code Insights tab.
5 Expand the Potential data type issues section. Then, expand the Expensive fixed-point

operations section.

The division operation in1/in2 uses the default rounding method, nearest. Changing the
rounding method to Floor provides a more efficient implementation.

Find and Address Expensive Comparison Operations
Comparison operations generate extra code when a casting operation is required to do the
comparison. For example, before comparing an unsigned integer to a signed integer, one of the inputs
must be cast to the signedness of the other. Consider optimizing the data types of the input
arguments so that a cast is not required in the generated code.

This example requires Embedded Coder and Fixed-Point Designer.

1 Create the function myRelop.

function out = myRelop(in1, in2)
    out = in1 > in2;
end

2 Generate code for myRelop.

cfg = coder.config('lib');
cfg.GenerateReport = true;
cfg.HighlightPotentialDataTypeIssues = true;
codegen -config cfg myRelop -args {fi(1, 1, 14, 3, 1), fi(1, 0, 14, 3, 1)}

3 Click View report.
4 In the code generation report, click the Code Insights tab.
5 Expand the Potential data type issues section. Then, expand the Expensive fixed-point

operations section.
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The first input argument, in1, is signed, while in2 is unsigned. Extra code is generated because
a cast must occur before the two inputs can be compared.

Change the signedness and scaling of one of the inputs to generate more efficient code.

Find and Address Multiword Operations
Multiword operations can be inefficient on hardware. When an operation has an input or output data
type larger than the largest word size of your processor, the generated code contains multiword
operations. You can avoid multiword operations in the generated code by specifying local fimath
properties for variables. You can also manually specify input and output word lengths of operations
that generate multiword code.

This example requires Embedded Coder and Fixed-Point Designer. In this example, the target word
length is 64.

1 Create the function myMul.

function out = myMul(in1, in2)
    out = in1 * in2;
end

2 Generate code for myMul.

cfg = coder.config('lib');
cfg.GenerateReport = true;
cfg.HighlightPotentialDataTypeIssues = true;
codegen -config cfg myMul -args {fi(1, 1, 33, 4), fi(1, 1, 32, 4)}

3 Click View report.
4 In the code generation report, click the Code Insights tab.
5 Expand the Potential data type issues section. Then, expand the Expensive fixed-point

operations section.

The report flags the in1 * in2 operation in line 2 of myMul.
6 In the code pane, pause over in1, in2, and the expression in1 * in2. You see that:

• The word length of in1 is 33 bits and the word length of in2 is 32 bits.
• The word length of the expression in1 * in2 is 65 bits.

The software detects a multiword operation because the word length 65 is larger than the target
word length of 64.

7 To resolve this issue, modify the data types of in1 and in2 so that the word length of the product
does not exceed the target word length. Alternatively, specify the ProductMode property of the
local fimath object.
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See Also

More About
• “Highlight Potential Data Type Issues in a Report” on page 91-2
• “Code Generation Reports”
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PIL Execution with ARM Cortex-A at the Command Line
This example shows how to set up a PIL execution to verify generated code at the command line.

You can use processor-in-the-loop (PIL) executions to verify generated code that you deploy to target
hardware by using a MATLAB Coder procedure. You can profile algorithm performance and speed for
your generated code. To verify generated code with the MATLAB Coder app, you must have an
Embedded Coder license.

This PIL execution is available with these hardware support packages. To use the PIL execution,
install one of these support packages.

• Embedded Coder Support Package for BeagleBone® Black Hardware
• Embedded Coder Support Package for ARM Cortex®-A Processors

In the Command Window, select the hardware for PIL execution.

hw = coder.hardware('ARM Cortex-A9 (QEMU)')

hw = 

  Hardware with properties:

            Name: 'ARM Cortex-A9 (QEMU)'
    CPUClockRate: 1000

When using the BeagleBone hardware, more hardware properties are supported (Username,
Password, and DeviceAddress). Set these properties based on your specific hardware or
application.

hw = coder.hardware('BeagleBone Black')

hw = 

  Hardware with properties:

             Name: 'BeagleBone Black'
     CPUClockRate: 1000
         Password: 'root'
         Username: 'admin'
    DeviceAddress: '192.168.1.10'

Add the hardware to the MATLAB Coder configuration object.

cfg = coder.config('lib','ecoder',true); 
cfg.VerificationMode = 'PIL'; 
cfg.Hardware = hw; 

Generate PIL code for a function, averaging_filter.

codegen -config cfg averaging_filter -args {zeros(1,16)}

For more information on the averaging_filter function, see “Generate Code for an Averaging
Filter”.

For another example of PIL verification, see the "Processor-in-the-Loop Verification of MATLAB
Functions" page in the documentation of the Embedded Coder Support Package for ARM Cortex-A
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Processors. To install the Embedded Coder Support Package for ARM Cortex-A Processors, see
“Embedded Coder Supported Hardware”.
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PIL Execution with ARM Cortex-A by Using the MATLAB Coder
App

You can use processor-in-the-loop (PIL) executions to verify generated code that you deploy to target
hardware by using a MATLAB Coder procedure. You can profile algorithm performance and speed for
your generated code. To verify generated code with the MATLAB Coder app, you must have an
Embedded Coder license.

This PIL execution is available with these hardware support packages. To use the PIL execution,
install one of these support packages.

• Embedded Coder Support Package for BeagleBone Black Hardware
• Embedded Coder Support Package for ARM Cortex-A Processors

You can set up PIL execution with the MATLAB Coder app.

To configure the build type and hardware board:

1 On the Generate Code page, in the Generate dialog box:

• Set the Build type to Static Library.
• Clear the Generate code only check box.
• Set the Hardware Board to BeagleBone Black or ARM Cortex-A9 (QEMU).

2 If necessary, modify the settings for your board. To modify the settings, click More Settings, and
then click Hardware.

3 To generate the library, click Generate.
4 Set up your PIL execution. Click Verify Code to open the Verify Code dialog box.

Because the hardware board is not MATLAB Host Computer, the Verify Code dialog box is
configured for PIL execution.

In the Verify Code dialog box:

• Enter the name of the test file to use for PIL execution.
• Select Generated code.

5 To start the PIL execution, click Run Generated Code.
6 To stop the PIL execution, click Stop.

For another example of PIL verification, see the "Processor-in-the-Loop Verification of MATLAB
Functions" page in the documentation of the Embedded Coder Support Package for ARM Cortex-A
Processors. Install the support package to view the documentation.
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Interactively Trace Between MATLAB Code and Generated C/C+
+ Code

This example shows how to trace between MATLAB source code and the generated C/C++ code.
Tracing between source code and generated code helps you to:

• Understand how the code generator implemented your algorithm.
• Debug issues in the generated code.
• Evaluate the quality of the generated code.

If you have Embedded Coder and enable production of a code generation report with traceability, you
can view MATLAB source code and generated C/C++ code next to each other. As you move your
pointer over code, you can follow highlighted traces to the corresponding generated code or source
MATLAB code.

Create the MATLAB Source Code
To illustrate interactive traceability, this example produces a report for generation of a C static
library for a MATLAB function lpsolve that solves the linear program:

• maximize y = c*x
• subject to A*x <= b
• where x >= 0 and b >= 0

lpsolve

%Attempts to solve the linear program:
%
%   maximize y = c*x
%   subject to: A*x <= b,
%   where x >= 0 and b >= 0
%
%   using the dictionary form of the simplex algorithm.
%
%   c must be a double, real row vector.
%   b must be a double, real column vector.
%   A must be a double, real, non-empty matrix with
%     size(A) = [length(b),length(c)].
%
%   Compare to
%   x = linprog(-c(:),A,b,[],[],zeros(length(c),1))
%   y = c*x
%   
%   Copyright 2011-2018 The MathWorks, Inc.

function [x,y] = lpsolve(c,A,b)
%#codegen
narginchk(3,3);
m = int32(size(A,1));
n = int32(size(A,2));
if ~validInputs(c,A,b)
    % Something is wrong with the inputs. Return NaNs.
    x = nan(n,1);
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    y = nan;
    return
end
cn = c;
nIdx = 1:n; % indices of non-basic variables
bIdx = n + (1:m); % indices of basic variables
% Perform iterations.
j = findPivotColumn(cn,nIdx);
unbounded = false;
while j > 0 && ~unbounded
    [i,r] = findPivotRow(j,A,b);
    if i == 0 || isinf(r)
        unbounded = true;
    else
        b(i) = r;
        % Take account of the variables entering and leaving the basis.
        entering = nIdx(j);
        leaving = bIdx(i);
        bIdx(i) = entering;
        nIdx(j) = leaving;
        [cn,A,b] = pivot(cn,A,b,i,j);
        j = findPivotColumn(cn,nIdx);
    end
end
% Construct the solution.
if unbounded
    x = nan(n,1);
    y = inf;
else
    x = zeros(n,1);
    y = 0;
    for k = 1:m
        j = bIdx(k);
        if j <= n
            x(j) = b(k);
            y = y + c(j)*x(j);
        end
    end
end

%-------------------------------------------------------------------------------

function p = validInputs(c,A,b)
coder.inline('never');
% All inputs must be double.
p = isa(c,'double') && isa(A,'double') && isa(b,'double');
% All inputs must be real.
p = p && isreal(c) && isreal(A) && isreal(b);
% A must be a non-empty matrix.
p = p && ismatrix(A) && ~isempty(A);
% c must be a row-vector with length = size(A,2).
p = p && isrow(c) && size(c,2) == size(A,2);
% b must be a column-vector with length = size(A,1).
p = p && iscolumn(b) && size(b,1) == size(A,1);
% The elements of b must be non-negative.
p = p && all(b(:) >= 0);

%-------------------------------------------------------------------------------
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function [c,A,b] = pivot(c,A,b,i,j)
% Pivot on element i,j.
coder.inline('never');
m = int32(size(A,1));
aij = A(i,j);
A(i,j) = 1;
A(i,:) = A(i,:)/aij;
for k = 1:m
    if k ~= i
        akj = A(k,j);
        A(k,j) = 0;
        A(k,:) = A(k,:) - akj*A(i,:);
        b(k) = b(k) - akj*b(i);
    end
end
cj = c(j);
c(j) = 0;
c = c - cj*A(i,:);

%-------------------------------------------------------------------------------

function j = findPivotColumn(c,idx)
% Find a suitable variable to enter the basis using the smallest
% subscript rule to prevent cycling.
coder.inline('never');
j = int32(0);
nc = int32(numel(c));
lastidx = int32(0);
for k = 1:nc
    if c(k) > 0 && (lastidx < 1 || idx(k) < lastidx)
        j = k;
        lastidx = idx(k);
    end
end

%-------------------------------------------------------------------------------

function [i,r] = findPivotRow(j,A,b)
% Find the pivot row in column j of A and also return r = b(i)/A(i,j).
coder.inline('never');
r = inf;
i = int32(0);
nb = int32(numel(b));
for k = 1:nb
    if A(k,j) > 0
        rtmp = b(k)/A(k,j);
        if rtmp < r
            r = rtmp;
            i = k;
        end
    end
end

%-------------------------------------------------------------------------------

The example also uses a test function lpsolve_test that calls lpsolve with representative input
values.
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lpsolve_test

% Test function for lpsolve
%
%   Copyright 2011-2018 The MathWorks, Inc.

function lpsolve_test()
c = [2 3 1 1];
A = [2 3 1 -1;1 0 2 1;0 2 1 1];
b = [27;9;18];
[x,y] = lpsolve(c,A,b);
x % display x
y % display y

Copy lpsolve.m and lpsolve_test.m to a writable folder.

copyfile(fullfile(docroot, 'toolbox', 'ecoder', 'examples', 'lpsolve.m'))
copyfile(fullfile(docroot, 'toolbox', 'ecoder', 'examples', 'lpsolve_test.m'))

Prepare for Code Generation
Before you generate C/C++ code, it is a best practice to screen your MATLAB code for code
generation readiness.

coder.screener('lpsolve')

The code generation readiness report indicates that lpsolve is suitable for code generation.

It is also a best practice to check for run-time issues by generating and testing a MEX function.

• To specify the types of the inputs arguments, pass representative input values to the codegen -
args option. Alternatively, because you have a test function, you can use coder.getArgTypes to
determine the types.

• To generate and test a MEX function, use the -test option.

c = [2 3 1 1];
A = [2 3 1 -1;1 0 2 1;0 2 1 1];
b = [27;9;18];
codegen lpsolve -args {c A b} -test lpsolve_test

Running test file: 'lpsolve_test' with MEX function 'lpsolve_mex'.

x =

     5
     7
     0
     4

y =

    35
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codegen successfully generates and runs the MEX function.

Produce a Code Generation Report with Traceability
To generate a report that has interactive traceability:

• Create a coder.EmbeddedCodeConfig object. The EnableTraceability property controls
traceability. By default, the EnableTraceability property is true.

• Specify the types of the input arguments by passing representative input values to the -args
option.

• Enable production of a code generation report by using the -report option.

cfg = coder.config('lib', 'ecoder', true);
codegen -config cfg lpsolve -args {c A b} -report

Access Trace Mode in the Report
To open the code generation report, click View report.

In the code pane, you see lpsolve.m.

To enable tracing, on the Report tab, click Trace Code.

You see the MATLAB source code and the generated C code next to each other.
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Trace Code
You can trace from the MATLAB code to the C code or from the C code to the MATLAB code.
Traceable code is marked with blue on the side that you are tracing from and with orange on the side
that you are tracing to. As you move your pointer over traceable code, the code is highlighted in
purple and you see the traces to the corresponding code on the other side. When you select
highlighted code by clicking it, the code becomes yellow and you can see the traces even when you
move your pointer away from the selection. The code remains selected until you press Esc or select
different code. To change the side that you are tracing from, select code on the other side.

Explore tracing in the example report.

1 In the MATLAB code, point to the while-loop that starts at line 38 and scroll down until the
entire while-loop is in view.
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You see this symbol that tells you that the highlighted MATLAB code has one trace that is not in
view.

You see the corresponding C code in a separate window in the C code pane.
2 In the C code pane, scroll down until you see the C code that corresponds to the while loop.

3 In the MATLAB code, move your pointer over different syntax elements in the while loop.
Highlight variables, expressions, and code blocks.

When you move your pointer over expressions that are part of larger expressions, different
shades of purple help you to find the relevant expression in the corresponding C code. For
example, at line 43, pause over i.

4 In the MATLAB code, move your pointer back to the while-loop that starts at line 38. When the
entire loop is highlighted in purple, select it by clicking. When you move your pointer outside of
the trace, the yellow highlighting identifies the selected trace.
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To clear the selection, press Esc or select different code.

View Multiple Traces
When code traces to more than one place in the corresponding source or generated code:

• If you pause over the code that you are tracing, at the top of the code pane, you see the number of
traces.

• If some traces are not in view, you see a symbol that tells you how many traces are out of view.

• In the code pane, if you select the code that you want to trace, at the top of the code pane, you can
select the trace that you want to see.

In the report for lpsolve, view multiple traces.

1 Pause over line 36.

At the top of the code pane, you see that line 36 has two traces.
2 Select line 36.

At the top of the code pane, you see the location of the first trace.
3 To list all traces, click the arrow to the right of the traces.

View Traces to Different Files
In the code generation report for lpsolve, all traces from the MATLAB code go to one C file
lpsolve.c. If MATLAB code traces to multiple C files, above the C code, you see a symbol such as

 that provides the number of additional files in which you can find a trace. If you click the symbol,
you can select the file that you want to see. If you select the MATLAB code, then you can select the
trace that you want to see.
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Likewise, above the MATLAB source code, a symbol such as  indicates that the highlighted C code
traces to multiple MATLAB files.

Switch the Locations of the Source and Generated Code
1 To view lpsolve.c on the left side of the code pane, in the list of generated files, click

lpsolve.c.
2 To view the MATLAB code on the left side of the code pane, click a MATLAB function, for

example, lpsolve.

Enable Code Tooltips and Links
When you are not in trace mode:

• In the MATLAB code, if you point to a variable or expression, a tooltip provides information such
as the type.

• In the C code, links go to other parts of the code such as type or function definitions.

When you are in trace mode, to enable MATLAB code tooltips and C code links, hold down Ctrl.
MATLAB code tooltips are available only for a selected MATLAB function.

In the report for lpsolve, view type information for a variable.

1 In the MATLAB Source pane, select pivot.
2 In the code pane, hold down Ctrl and pause over the input argument i.
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Note On a Macintosh platform, use the Command key instead of Ctrl.

Disable Traceability
To produce a code generation report that does not include traceability:

• In a coder.EmbeddedCodeConfig object, set the EnableTraceability property to false.
• In the MATLAB Coder app, set Enable code traceability to No.

See Also
coder.EmbeddedCodeConfig

More About
• “Tracing Generated C/C++ Code to MATLAB Source Code”
• “Code Generation Reports”
• “Configure Build Settings”
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Polyspace Verification of C/C++ Code Generated by MATLAB
Coder

To check for run-time errors in C/C++ code generated from MATLAB code, you can use Polyspace
Code Prover. To check for defects, you can use Polyspace Bug Finder. If you have Polyspace and
Embedded Coder, Polyspace is integrated into the MATLAB Coder workflow.

• In the MATLAB Coder app, you can run Polyspace analysis without additional setup.
• At the command line, after code generation with codegen, you can run Polyspace analysis on the

generated code by providing the code generation output folder to pslinkrun.

Run Polyspace Analysis in the MATLAB Coder App
1 Generate standalone C/C++ code (a static library, dynamically linked library, or executable

program).
2 On the Generate Code page, click Polyspace.
3 Select the options. See “Configure Advanced Polyspace Options in MATLAB Coder App”

(Polyspace Code Prover).
4 Click Run.

The app logs the analysis output on the Polyspace Log tab and opens the Polyspace user
interface.

Run Polyspace Analysis on Code Generated by codegen
1 Create a pslinkoptions object for verification of code generated by MATLAB Coder.
2 As needed, change object properties:

• In the ResultDir property, specify the name of the folder for the Polyspace results.
• In the VerificationMode property, specify the Polyspace verification product.

3 Run the verification by using pslinkrun. Provide the pslinkoptions object and the folder that
contains the generated code.

4 To view verification results, open the Polyspace user interface.

For example, suppose that you generated a static library for the MATLAB function myFunction and
that the code generation output folder is codegen/lib/myFunction. To run Polyspace Code Prover
on the generated code, use this code:

opts = pslinkoptions('codegen');
opts.ResultDir = 'polyspace';
opts.VerificationMode = 'CodeProver';
pslinkrun('-codegenfolder', 'codegen/lib/myFunction', opts);
polyspaceCodeProver('polyspace/myFunction.psprj');

You can also set the VerificationMode property to 'BugFinder' and view verification results by
using polyspaceBugFinder.

Review Analysis Results
In the Results List pane of the Polyspace user interface, review the run-time checks. See whether
you can trace the issues back to the original MATLAB code. See “Interactively Trace Between
MATLAB Code and Generated C/C++ Code” on page 91-12.
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For example, an operation in the C code might overflow because Polyspace assumes an unbounded
range for a function input. Consider specifying a constraint on the input and reanalyzing the code
with Polyspace. See “Run Polyspace on C/C++ Code Generated from MATLAB Code” (Polyspace Code
Prover).

See Also
pslinkoptions | pslinkrun

More About
• “Run Polyspace on C/C++ Code Generated from MATLAB Code” (Polyspace Code Prover)
• “Configure Advanced Polyspace Options in MATLAB Coder App” (Polyspace Code Prover)
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